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What’s new in Final Cut Pro 10.0.6?
Final Cut Pro 10.0.6 includes numerous new features and enhancements, detailed below.
Advanced multichannel audio editing
Final Cut Pro automatically groups audio channels into audio components according to how the 
channels are configured for the clip. You can now expand the audio portion of clips to view and 
edit audio components down to the individual channel level. You can edit audio components in 
a variety of ways, including any of the following:
• Adjust volume or pan.
• Disable or delete ranges within an audio component to quickly edit out unwanted sounds.
• Apply and adjust audio effects.
• Add or remove audio components in a multicam clip.
For more information, see Audio editing overview on page 168.
Streamlined sharing and export
Sharing your finished work is easier and more flexible in Final Cut Pro 10.0.6. Destinations—sets 
of preconfigured export settings—allow you to quickly publish a project or clip to a sharing 
website, export it for viewing on iPad or iPhone, or burn it to a disc. Final Cut Pro comes with a 
variety of destinations, and you can also modify destinations and create new destinations.
The simplified and streamlined sharing workflow includes these enhancements: 
• Simplified and consolidated menus that you can easily populate with customized destinations
• Reusable destination bundles that allow you to share to multiple output formats and locations 
at once
• Automatic sharing of project and clip metadata, with the ability to customize the metadata 
that is shared
• Support for multiple accounts at video-sharing websites such as YouTube
• Faster sharing and export using the GPU and background processing
• Sharing of a selected range in a project in the Timeline or in a clip in the Event Browser
For more information, see Sharing projects overview on page 377.
Unified import
Simplified and easier to use, the new unified Media Import window provides one place to go for 
all your importing needs. Final Cut Pro 10.0.6 offers dedicated areas for connected cameras and 
devices, both file-based and tape-based, as well as a new Favorites section, where you can add 
frequently used folders for file import from your hard disk or an external drive. Other new import 
features include list view to see multiple columns of metadata, multiple range selections within 
individual clips from file-based cameras, and complete archive-management tools.
For more information, see Importing overview on page 19.
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Dual viewers
The Event Viewer is a separate video display that appears next to the main Viewer so you can 
compare shots to match action and color. With the Event Viewer and the Viewer open, you can 
display two clips at the same time: one from the Event Browser and one from the Timeline, each 
with its own video scope display.
For more information, see Play back and skim media in the Event Viewer on page 78.
Native REDCODE RAW (R3D) support
Final Cut Pro 10.0.6 provides native support for REDCODE RAW (R3D) files. You can now import 
RED files directly, make nondestructive RAW settings adjustments, and save those adjustments 
as metadata, all within Final Cut Pro. This allows you to take advantage of the full latitude and 
dynamic range contained in the REDCODE RAW source files.
For more information, see Import and adjust REDCODE RAW video files on page 43.
Improved range selections
Start and end points in clips in the Event Browser now stay in place when you click elsewhere. 
You can also create multiple range selections in one or more clips. 
For more information, see Select a range on page 93 and Manage multiple range selections in 
event clips on page 96.
Other notable features
• Chapter markers and chapter marker thumbnails allow you to prepare chapters and their 
representative poster frame images directly within Final Cut Pro for output to DVD, Blu-ray 
disc, iTunes, QuickTime Player, and Apple devices.
• The new Paste Attributes window is a powerful way to transfer specific effects and other 
settings between clips.
• You can now add freeze frames quickly and easily with a single keyboard shortcut.
• Titling is significantly improved, including support for the new title markers feature in Motion.
• Flexible connection points improve manual control over connected clips as you slip, slide, or 
move clips in the primary storyline.
• New compound clip architecture makes compound clips easier to reuse in multiple projects 
and provides improved performance.
• You can now import and export MXF files using third-party plug-ins. For a list of supported 
media files, see Supported media formats on page 41.
• Final Cut Pro 10.0.6 provides improved support for anamorphic media.
What’s new in Final Cut Pro 10.0.3?
Final Cut Pro 10.0.3 includes major new features and enhancements, detailed below.
Multicam editing
You can now use multicam clips to edit footage from multicamera shoots or other synchronized 
footage in real time. Working with multicam clips in Final Cut Pro is a flexible and fluid process. 
While the active angle plays in the Viewer, you can also view all angles playing simultaneously in 
the Angle Viewer and easily cut and switch between them. You can create multicam clips from 
diverse media sources and modify existing multicam clips during the editing process.
For more information, see Multicam editing overview on page 308.Chapter 1 What’s new in Final Cut Pro? 12
A/V output
You can now connect your computer to an external video monitor for audio and video (A/V) 
output. In addition to showing you how video and audio look and sound on an NTSC/PAL or HD 
broadcast monitor, this feature also allows you to test output with more sophisticated devices 
such as vectorscopes and waveform monitors.
A/V output is available only with OS X Lion v10.7.2 or later and requires compatible thirdparty video interface hardware and software. FireWire DV devices are not supported. For more 
information, contact the device manufacturer or go to the Final Cut Pro X Resources webpage at 
http://www.apple.com/finalcutpro/resources.
For more information, see View playback on an external video monitor on page 79.
Manual relinking of clips to media files
Now you can manually relink event clips and project clips to media files. Manual relinking gives 
you more control over your post-production workflow. 
For more information, see Relink clips to media files on page 393.
Other notable features
• Layered graphics files, such as Adobe Photoshop (PSD) files, can now be edited so that each 
layer appears as a connected clip in the Timeline.
• Advanced Keyer controls are now available.
• Keyframing controls are improved in the Video and Audio Animation Editors.
What’s new in Final Cut Pro 10.0.1?
Final Cut Pro 10.0.1 includes a number of new features, enhancements, and changes. The most 
significant features are introduced below.
Roles
You can use the new roles metadata labels to organize clips in your events and projects, control 
the appearance of the Timeline, and export separate video or audio files (also known as media 
stems) for broadcast delivery, audio mixing, or post-production. For example, you can export 
roles as media stems in a combined, multitrack QuickTime file, or as separate audio or video 
files. During the export process you can assign mono, stereo, or surround output for your 
audio channels.
For more information, see Roles overview on page 299 and Destinations preferences on 
page 422.
Storage area network (SAN) locations
You can now add network volumes as storage locations for events and projects. When you 
remove SAN locations in Final Cut Pro, other users on the network can work with the events 
and projects stored on those locations.
For more information, see Use SAN locations for events and projects on page 410.
XML export and import
Final Cut Pro now supports XML import and export so that you can transfer your project and 
event information to and from systems and third-party applications that don’t recognize 
Final Cut Pro projects and events. 
For more information, see Use XML to transfer projects and events on page 307.13
What is Final Cut Pro?
Final Cut Pro X is a revolutionary application for creating, editing, and producing the highestquality video. Final Cut Pro combines high-performance digital editing and native support 
for virtually any video format with easy-to-use and time-saving features that let you focus 
on storytelling.
In Final Cut Pro, you can:
• Edit everything from uncompressed standard-definition video to HDV, DVCPRO HD, and 
uncompressed high-definition video—as well as file-based formats such as AVC-Intra, AVCHD, 
and XDCAM HD.
• Play back and skim resolution-independent media up to 1920 x1080, 2K, 4K, and even 5K 
resolution. You can also play your video full screen or on a second display.
• Assemble clips with ease using the Magnetic Timeline, which fluidly adjusts clips around the 
clip you’re dragging to eliminate gaps, collisions, and sync problems.
• Edit quickly with the complete set of professional editing and trimming tools. Fine-tune edits 
with the inline Precision Editor.
• Have Final Cut Pro analyze your video and nondestructively fix common problems such as 
camera shake, excess hum, or loudness. You can also have Final Cut Pro detect the presence of 
people or the shot type, and automatically apply keywords such as One Person or Wide Shot.
• Organize your media using Keyword Collections, which automatically group clips based on 
keywords, and Smart Collections, which automatically group clips based on criteria you specify.
• Try out clips in your project using auditions—sets of alternate takes, effects, or text 
treatments—and then choose the best clip for the edit.
• Create compound clips to group any combination of clips, and nest clips within other clips. 
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• Use connected clips and storylines to add cutaway shots, superimposed titles, and sound 
effects to your project. Connected clips and storylines always stay in sync.
• Add special effects to video, audio, and photos, and adjust them using keyframes and onscreen 
controls. You can also change clip speed to create fast-motion or slow-motion effects.
• Automatically balance and match color, or use the color correction tools to precisely control 
the look of any clip in your project.
• Publish your project directly to websites such as YouTube and Facebook, or send your project 
to iTunes for syncing with Apple devices such as iPhone, iPad, and Apple TV.
Final Cut Pro workflow overview
To give you an idea of the possibilities, the overall process for putting together a movie with 
Final Cut Pro is described below. You don’t have to do every step, and you might do others that 
aren’t listed. The workflow isn’t necessarily linear. You could, for example, go all the way through 
editing and adding effects, and then import more new media for your project.
Import your media into Final Cut Pro
To use Final Cut Pro, you need to transfer your media (video, audio, and still images) from your 
recording device to your computer or an external disk. You can import media from many kinds 
of cameras and other devices, or from other applications such as iMovie.
Organize your media
Final Cut Pro automatically organizes your imported media into events. An event is like a folder 
that contains all the media recorded on a certain date. In Final Cut Pro, your media appears as 
clips, which link to the media files stored on a disk. You can reorganize your clips by creating or 
renaming events and moving clips between events. For example, you could create an event for 
all the media shot for a specific client.
As you review your footage, you can easily rate clips as Favorite or Rejected. These ratings make 
it easier to focus on your best footage. Final Cut Pro also offers other useful organizing tools, such 
as Keyword Collections and Smart Collections.
Create a project and add clips to it
Your project is the movie you create using clips from your events and from the Final Cut Pro 
media browsers. Start creating your movie by adding clips to the Timeline. You make all 
your edits in the project; your original media files remain untouched (this is known as 
nondestructive editing).
Arrange and edit your clips
Now your movie can really begin to take shape. To assemble a rough cut, rearrange and trim 
clips in the Timeline. You can also try out different clips using auditions. Use connected clips 
and storylines to add cutaway shots, titles, background music, and sound effects to your project. 
Create compound clips to group any combination of clips and nest clips within other clips. You 
can simplify a complicated project by creating a separate compound clip for each major section. 
Add effects and transitions
Add special effects from the ample collection of video and audio effects in the Final Cut Pro 
media browsers. Give your movie titles and credits, and apply video or audio transitions. Adjust 
clip speed settings to create fast-motion or slow-motion effects. 
To further polish your project, you can fine-tune cuts and transitions with the Precision Editor, 
keyframe video and audio effects, correct color, and composite motion graphics.Chapter 2 Final Cut Pro basics 15
Share your movie
When your project is finished, you can publish your movie right from Final Cut Pro to the web, or 
send it to iTunes, iPhone, iPad, iPod, or Apple TV. You can also burn a disc to give to others.
Final Cut Pro interface overview
The Final Cut Pro window has three main areas:
Viewer: Play back 
clips and projects.
Event Browser: Access all 
the source media you import.
Magnetic Timeline: Edit your 
movie in this area.
Organize media in the Event Library and Event Browser
All your imported media is available in the Event Library. (An event is like a folder that contains clips.)
When you select an event in the Event Library, its clips appear in the Event Browser on the right.
Event Browser: View and sort 
the clips in the selected event.
Event Library: Select an event 
to view its media on the right.
You can reorganize your media however you like at any time, and you can use the Event Library 
and the Event Browser to manage, rate, sort, and add keywords to your imported media. For 
more information, see Events and clips overview on page 51. Chapter 2 Final Cut Pro basics 16
Play back clips and projects in the Viewer
The Viewer is where you play back your video, including clips and projects with up to 1920 x 
1080, 2K, 4K, and even 5K resolution. You can play back events, projects, or individual clips in fullscreen view or on a second display. With the Event Viewer, a separate video display that can be 
shown next to the main Viewer, you can display two clips at the same time: one from the Event 
Browser and one from the Timeline. For information about ways to play media, see Play back 
media on page 74.
Resolution-independent playback: 
Play back video files up to 5K.
Full-screen playback: 
Play your video full screen, 
or on a second display.
Onscreen controls: 
Adjust effects such as 
Transform, Crop, and Distort.
Dual viewers: Display event clips 
and project clips side by side.
You can also use onscreen controls, superimposed over the video in the Viewer, to adjust settings 
for a wide array of effects and transitions.
Edit your project in the Magnetic Timeline
The bottom portion of the Final Cut Pro window contains the Timeline, where you create your 
movie by adding and arranging clips and making all your edits. The Timeline in Final Cut Pro 
“magnetically” adjusts clips to fit around clips that you drag into place. If you drag clips out of 
place, the surrounding clips close up to fill the space.
A Final Cut Pro project holds all of the information for your final movie, including your editing 
decisions and links to all the source clips and events. For more information about editing your 
project, see Adding clips overview on page 99 and Arrange clips in the Timeline on page 117.
Toolbar: Perform 
common tasks by 
clicking a button.
Connected clips: Add titles and 
cutaway shots. In the Magnetic 
Timeline, everything stays in sync.
Audio clips: Add music 
and sound effects as 
connected clips.
Primary storyline: Add and 
arrange clips to construct 
your movie.Chapter 2 Final Cut Pro basics 17
Media files and clips
After you import media into Final Cut Pro, clips representing the source media files appear in the 
Event Browser. A large event may hold many clips.
Media files are the raw materials you use to create your project. A media file is a video, audio, 
still-image, or graphics file on your hard disk that contains footage transferred from a camcorder 
or recording device or originally created on your computer. Media files can contain multiple 
video and audio components. Because media files—especially video files—tend to be quite 
large, projects that use a lot of footage require one or more high-capacity hard disks.
Clips represent your media, but they are not the media files themselves. The clips in a project 
simply point to (link to) the source media files on your hard disk. When you modify a clip, you 
are not modifying the media file, just the clip’s information in the project. This is known as 
nondestructive editing, because all of the changes and effects you apply to clips in Final Cut Pro 
never affect the media itself. Trimmed or deleted pieces of clips are removed from your project 
only, not from the source clips in your Event Library or from the source media files on your 
hard disk.
Project 2
Toy1
Event clips
Media files on your hard disk
Project 1 Project 3
Toy1.mov
Toy1
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Events and projects
In Final Cut Pro X, you use events to collect and organize media. Events are like folders that 
contain unedited media imported from a camera or some other source.
You use projects to edit and construct movies and share them with your audience. A project is 
a record of the work you do in the Timeline and the editing decisions you make. When you add 
a clip from an event to a particular project, you create a link between the source event clip and 
the corresponding project clip (and, by extension, between the event and the project). However, 
neither the event nor the source clip is contained within the project. You can use that event clip 
in other projects, and your project can use clips from other events.
The illustration below shows the relationship between events and projects: Final Cut Pro X keeps 
track of the links between project clips and their source event clips, but projects and events 
remain independent.
Project
Project
Event
Event
Event
Event19
Importing overview
Importing media into Final Cut Pro is the first step toward making your movie. With Final Cut Pro, 
you can:
• Import from a file-based (tapeless) camera or device
• Import from iPhone, iPad, or iPod touch
• Import from a tape-based camcorder or device
• Import from iMovie
• Import from iPhoto and Aperture
• Import from iTunes
• Import from a hard disk
• Import from a camera archive
During import, you assign your media to an event. You can also transcode your media and 
analyze your media for a variety of issues, such as color balance, the presence of people and shot 
type, and audio problems.
When you import clips (video, audio, or still images), Final Cut Pro assigns one of five default roles 
to the video and audio components of each clip: Video, Titles, Dialogue, Music, and Effects. For 
more information, see View and reassign roles on page 300.
If you want to quickly back up your media (instead of taking the time to import it), you can 
create an archive.
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If it’s your firstimport
The first time you open Final Cut Pro, it contains no media, no projects, and a single event. Buttons 
appear in the Event Browser to help you quickly import events from iMovie, media from your 
hard disk or a connected external storage device, or media directly from a connected camera.
Import media into an empty event
m To import events from iMovie: Click the Import iMovie Events button and follow the instructions 
for importing iMovie events.
m To import files from a connected camera or from a hard disk: Click the Import Media button and 
follow the instructions for importing files from a connected file-based camera, from a hard disk, 
from a tape-based camera, or from a camera archive.
Importfrom connected cameras
Import from file-based cameras
File-based camcorders and cameras can record video, audio, and still images. These kinds of 
devices, which record to flash-based storage media, hard disk drives (HDD), and so on, usually 
connect to your computer via a USB cable. Some devices have removable memory cards that you 
can insert into your computer instead.
If your file-based device provides a clip-spanning feature, you can import all of the media as one 
spanned clip.
To check whether your camera is compatible with Final Cut Pro, go to the Final Cut Pro X 
Supported Cameras webpage at http://help.apple.com/finalcutpro/cameras.
Import from a file-based camcorder, camera, or device
1 Do one of the following:
• Connect your camcorder, camera, or device to your computer, using the cable that came with 
the device, and turn it on.
If you’re using a camcorder, set it to PC Connect mode. (The name of this transfer mode may 
be different on your device.) Your camcorder may automatically go into “connect” mode if you 
turn it on in playback mode while it’s connected to your computer. For more information, see 
the documentation that came with your camcorder.
Note: Connecting a DVD camcorder to your Mac can cause the DVD Player application to 
open. If that happens, simply close DVD Player.Chapter 3 Import media 21
• Remove the memory card from your camcorder or device and insert it into the card slot on 
your Mac (if it has one) or into an external card reader.
For more information about memory cards, see About memory cards and cables on page 40.
2 To open the Media Import window, do one of the following:
• Choose File > Import > Media (or press Command-I).
• Click the Import Media button on the left end of the toolbar.
3 If necessary, select your camcorder, camera, or device from the Cameras section on the left.
The Media Import window displays all the media on your device. In this window you can preview 
the media by either playing it using the playback controls or skimming it by moving the pointer 
forward or backward over a filmstrip. 
Change the way clips appear 
using these controls.
The media on the 
device appears here.
Playback controls
Note: Most modern digital cameras can shoot still images and video interchangeably. In 
many cases, the video clips and still images in those cameras appear side by side in the 
Media Import window.
4 Do any of the following:
• To change which device to import from: Click the device in the Cameras section.
• To change the way the clips appear: Click the Clip Appearance button in the bottom-right 
corner of the Media Import window.
• To switch between filmstrip view and list view: Click the List View and Filmstrip View buttons 
at the bottom of the Media Import window. (Connected file-based cameras and camera 
archives only.)
Note: When you select a clip in list view, a filmstrip for the selected clip appears at the top 
of the Event Browser. The filmstrip is fully interactive, allowing access to start and end points, 
markers, and keywords.Chapter 3 Import media 22
• To sort clips in list view by data such as duration, creation date, rating, keyword, and so on: Click 
the column headings at the top of list view. For more information about list view, see Import 
from a hard disk on page 34.
• To add folders of frequently used media to the Favorites section: Drag them from list view.
To remove a folder from the Favorites section, Control-click the folder and choose Remove 
from Sidebar in the shortcut menu.
• To automatically close the Media Import window when the import begins: Select the “Close 
window after starting import” checkbox.
• To add a folder to the list view by dragging: Drag the folder from the Finder to the list view and 
browse its contents in list view.
5 Do one of the following:
• To import all clips: Click Import All.
• To import only some of the clips: Select each clip you want to import by Command-clicking each 
clip, and click Import Selected (the Import button changes its name).
Tip: To select several clips located together, you can drag around the clips to enclose them 
with the selection rectangle.
• To import portions of clips: Drag inside the filmstrip to select the range that you want, and click 
Import Selected. You can also select multiple ranges in each clip. For more information, see 
Select a range on page 93.
Tip: You can also select a clip, press the Space bar to play the clip, and press either I to set a 
start point or O to set an end point.
6 In the window that appears, choose how you want to organize the imported media in the 
Event Library:
• To add the imported clips to an existing event: Select “Add to existing event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field; then choose the disk where you want to store the event from the 
“Save to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
7 If you want to organize your media, create optimized or proxy media, analyze the video, or 
analyze the audio, select the relevant checkboxes.
If you don’t set Final Cut Pro to analyze your media during the import process, you can analyze it 
later (if necessary) in the Event Browser.
8 Click Import.
By default, the Media Import window closes when you click Import. You can begin working with 
your clips in the Event Browser. Final Cut Pro imports your media in the background.
If you selected any options in the previous step, Final Cut Pro transcodes and optimizes the 
files after the import process is complete. You can view the progress of the import and other 
background tasks in the Background Tasks window. 
9 When background tasks are completed, disconnect the camcorder, camera, or device.
You can create an archive from your file-based or tape-based camera or device. For more 
information, see Create and manage camera archives on page 411.Chapter 3 Import media 23
Reimport a clip
Two situations warrant reimporting a clip:
• If the clip was not completely imported: If you cancel or quit Final Cut Pro before an import is 
finished, a Camera icon appears on the bottom-left corner of the clip. This icon indicates that 
Final Cut Pro is using the media on the camera for playback (instead of using the QuickTime 
file that was created during import).
Camera icon
To play a clip with a Camera icon, Final Cut Pro locates the media on either a connected 
camera or in a connected, available camera archive. (See Access media on an archive or disk 
image on page 36 for more information.) If Final Cut Pro can’t locate the media in one of those 
locations, the clip will go offline and display the Missing Camera alert icon.
• If the clip’s source media file is not available: If a clip’s source media file is moved or deleted, or 
the volume it is located on is disconnected from the computer, a Missing File icon is displayed 
on the clip. To restore the clip, you can reimport it.
See Alert icons on page 414 for more information about alert icons.
When you reimport a clip, Final Cut Pro automatically connects to the necessary camera or 
camera archive. There is no need to manually mount a camera archive before reimporting. 
1 Do one of the following:
• Connect the camera that contains the clip to your computer, and turn it on. This will bring the 
clip online, but the clip will still display the Camera icon in the lower-left corner.
• Insert the memory card that contains the clip in your computer or connected card reader.
See About memory cards and cables on page 40 for more information.
• Make sure the camera archive that contains the clip is located in one of the Final Cut Pro 
camera archives.
See Create and manage camera archives on page 411 for more information.
2 In Final Cut Pro, do one of the following:
• To reimport one clip: Select the clip in the Event Browser.
• To reimport all clips in an event: Select the event in the Event Library.
3 Choose File > Import > Reimport from Camera/Archive.
The clip or clips are reimported.Chapter 3 Import media 24
Import spanned clips
Some file-based camcorders or devices that have more than one memory card slot can record 
one shot over multiple memory cards. The resulting shot is called a spanned clip.
A good way to import a spanned clip into Final Cut Pro is to attach your camera or card reader 
to your local system and create a camera archive for each memory card. You can store the 
camera archives on your local system or on an external storage device until you are ready to 
import the spanned clip. (Even if you are importing the spanned clip immediately, it’s useful to 
make the camera archive so you have a backup of the footage that makes up the spanned clip.) 
Then, when you’re ready to import, you can mount all of the camera archives and import the 
spanned clip.
Create a camera archive for each memory card
1 Connect your camcorder or camera to your computer and turn it on, or connect your card 
reader and memory card to your computer. If you’ll be saving the camera archives to an external 
storage device, connect that as well.
2 In Final Cut Pro, do one of the following:
• Choose File > Import > Media (or press Command-I).
• Click the Import Media button on the left end of the toolbar.
The Media Import window appears. 
3 Select a memory card to archive from the list of cameras on the left.
4 Click the Create Archive button at the bottom-left corner of the window.
5 In the “Create Camera Archive as” field, type a name for the archive.
6 Choose a location to save the archive from the Destination pop-up menu, and click OK.
Note: To protect your media, it is recommended that you save your archive to a disk or partition 
different from the one where you store the media files used with Final Cut Pro.
7 Repeat steps 3 through 6 to create camera archives for each of the memory cards that contain a 
portion of the spanned clip.
The camera archives appear in the Camera Archives list in the Media Import window.
See Create and manage camera archives on page 411 for more information about creating 
camera archives.
Import a spanned clip
1 If your camera archives are stored on an external storage device, make sure that it is connected 
to your local system.
2 Choose File > Import from Camera.
The Media Import window appears, showing all camera archives on your local system (and on 
any connected external storage devices) in the Camera Archives section on the left. Chapter 3 Import media 25
3 Select each camera archive that makes up the spanned clip.
Final Cut Pro mounts all of the camera archives. If all portions of the spanned clip are available, 
all the mounted camera archives show a clip with the same duration. An icon indicating that the 
spanned clip is complete appears on the spanned clip.
These camera archives 
contain all portions 
of the spanned clip.
This clip represents the 
complete spanned clip.
This icon indicates that all 
portions of the spanned 
clip are available.
If one or more camera archives are missing, an icon appears on the spanned clip to indicate 
which part of the spanned clip is available—the beginning, middle, or end. You can select each 
camera archive to see the different icons.
Indicates that all 
portions of the spanned 
clip are available.
Indicates that the end 
portion of the spanned 
clip is available.
Indicates that the 
beginning portion of the 
spanned clip is available.
Indicates that the middle 
portion of the spanned 
clip is available.
4 Click Import All to import the spanned clip.
Important: If the camera archives that make up the spanned clip are not all available, you can 
import each camera archive separately. Each portion of the spanned clip will be imported into 
Final Cut Pro as a separate clip.Chapter 3 Import media 26
5 Choose how you want to organize the imported media in the Event Library:
• To add the imported media to an existing event: Select “Add to existing event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field; then choose the disk where you want to store the event from the 
“Save to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
6 If you want to organize your media, transcode your media, analyze the video, or analyze the 
audio, select the relevant checkboxes.
If you don’t set Final Cut Pro to analyze your media during the import process, you can analyze it 
later (if necessary) in the Event Browser.
7 Click Import.
Final Cut Pro imports your media in the background. If you selected any options in the previous 
step, Final Cut Pro transcodes and optimizes the files after the import process is complete. You 
can view the progress of the background tasks in the Background Tasks window.
8 To begin working with your clips, close the Media Import window so you can access the 
Event Browser.
Import from iPhone, iPad, or iPod touch
Importing media from iPhone, iPad, or iPod touch is the same as importing it from a file-based 
camcorder, camera, or device.
Import from iPhone, iPad, or iPod touch
1 Connect your iPhone, iPad, or iPod touch to your computer using the Dock Connector to USB 
cable that came with it. (If another application opens, close it.) Then turn on your device and 
unlock it.
2 In Final Cut Pro, do one of the following:
• Choose File > Import > Media (or press Command-I).
• Click the Import Media button on the left end of the toolbar.
The Media Import window appears.
3 If necessary, select your iPhone, iPad, or iPod touch from the Cameras section on the left.
The Media Import window displays all the media on your device. In this window you can preview 
the media by either playing it using the playback controls or skimming it by moving the pointer 
forward or backward over a filmstrip. 
You can also do any of the following:
• To change which device to import from: Click the device in the Cameras section.
• To change the way the clips appear: Click the Clip Appearance button in the bottom-right 
corner of the Media Import window.Chapter 3 Import media 27
• To switch between filmstrip view and list view: Click the List View and Filmstrip View buttons 
at the bottom of the Media Import window. (Connected file-based cameras and camera 
archives only.)
Note: When you select a clip in list view, a filmstrip for the selected clip appears at the top 
of the Event Browser. The filmstrip is fully interactive, allowing access to start and end points, 
markers, and keywords.
• To sort clips in list view by data such as duration, creation date, rating, keyword, and so on: Click 
the column headings at the top of list view. For more information about list view, see Import 
from a hard disk on page 34.
• To add folders of frequently used media to the Favorites section: Drag them from list view.
To remove a folder from the Favorites section, Control-click the folder and choose Remove 
from Sidebar in the shortcut menu.
• To automatically close the Media Import window when the import begins: Select the “Close 
window after starting import” checkbox.
• To add a folder to the list view by dragging: Drag the folder from the Finder to the list view 
and browse its contents in list view.
4 Do one of the following:
• To import all clips: Click Import All.
• To import only some of the clips: Select each clip you want to import by Command-clicking each 
clip, and click Import Selected (the Import button changes its name).
Tip: To select several clips located together, you can drag around the clips to enclose them 
with the selection rectangle.
• To import portions of clips: Drag inside the filmstrip to select the range that you want, and click 
Import Selected. You can also select multiple ranges in each clip. For more information, see 
Select a range on page 93.
Tip: You can also select a clip, press the Space bar to play the clip, and press either I to set a 
start point or O to set an end point.Chapter 3 Import media 28
5 In the window that appears, choose how you want to organize the imported media in the 
Event Library:
• To add the imported clips to an existing event: Select “Add to existing event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field; then choose the disk where you want to store the event from the 
“Save to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
6 If you want to create optimized or proxy media, analyze the video, or analyze the audio, select 
the relevant checkboxes.
If you don’t set Final Cut Pro to analyze your media during the import process, you can analyze it 
later (if necessary) in the Event Browser.
7 Click Import.
By default, the Media Import window closes when you click Import. You can begin working with 
your clips in the Event Browser. Final Cut Pro imports your media in the background.
If you selected any options in the previous step, Final Cut Pro transcodes and optimizes the 
files after the import process is complete. You can view the progress of the import and other 
background tasks in the Background Tasks window. 
8 When background tasks are completed, disconnect the iPhone, iPad, or iPod touch.
Import from a digital still camera
You can import video and still images from digital still cameras. The steps below describe how 
to import video and still images directly into Final Cut Pro. You can also import your photos into 
Aperture or iPhoto and access them through the Photos Browser in Final Cut Pro.
To check whether your camera is compatible with Final Cut Pro, go to the Final Cut Pro X 
Supported Cameras webpage at http://help.apple.com/finalcutpro/cameras.
Import still-image clips and video clips from a digital still camera
1 Connect your camera to your computer using the cable that came with the camera, and turn 
it on.
If your camera doesn’t appear on the left side of the Media Import window (either in the 
Cameras or Devices section), remove the camera’s memory card and insert it into the card slot on 
your Mac (if it has one) or into an external card reader.
2 In the Finder, locate the DCIM folder inside the camera folder, and then locate the still-image or 
video files. The files may be in the DCIM folder, or in a folder one or two levels down. Devices and 
file structures vary by model and manufacturer.
3 In Final Cut Pro, do one of the following:
• Choose File > Import > Media (or press Command-I) and follow the instructions in Import 
from a hard disk on page 34.
• Drag the files from the Finder into an event or Timeline in Final Cut Pro. The files will be 
imported using the import settings you configured in Import preferences. See Import from a 
hard disk on page 34.
After import, you may have separate audio files that you want to use to replace the video’s audio 
track. To do this, you can automatically synchronize the video and audio clips.Chapter 3 Import media 29
Import from tape-based cameras
You can import media from a tape-based camcorder or tape-based device. To determine 
which clips you want to import (rather than importing all of them), you can view them using 
Final Cut Pro before you import them.
Final Cut Pro supports tape-based import of the following formats: DV (including DVCAM, 
DVCPRO, and DVCPRO50), DVCPRO HD, and HDV.
To check whether your camera is compatible with Final Cut Pro, go to the Final Cut Pro X 
Supported Cameras webpage at http://help.apple.com/finalcutpro/cameras.
Import media from a tape-based camcorder or device
1 Connect the camcorder to your computer using the cable that came with it, and configure your 
device for remote control over FireWire, if necessary.
Note: For best results when importing from a tape-based camcorder, it is recommended that you 
import the video using the same camcorder that you used to record it.
2 Turn on the camcorder and set it to VTR or VCR mode. (This mode may have a different name on 
your camera. For more information, see the documentation that came with your camcorder.)
3 In Final Cut Pro, do one of the following:
• Choose File > Import > Media (or press Command-I).
• Click the Import Media button on the left end of the toolbar.
The Media Import window appears.
4 If you have multiple devices connected to your computer, choose the device you want to import 
from in the list of cameras on the left.
The Media Import window displays the image from the current position of the tape.
5 Use the playback controls (or use the J, K, and L keys) to set your tape to the point where you 
want to begin importing, and click Import.Chapter 3 Import media 30
6 In the window that appears, choose how you want to organize the imported media in the 
Event Library:
• To add the imported clips to an existing event: Select “Add to existing event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field; then choose the disk where you want to store the event from the 
“Save to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
7 If you want to transcode your media, analyze the video, or analyze the audio, select the 
relevant checkboxes.
If you don’t set Final Cut Pro to analyze your media during the import process, you can analyze it 
later (if necessary) in the Event Browser.
8 Click Import.
Final Cut Pro begins importing immediately from the current location on the tape. It will 
continue to import (and save the resulting media file to the event you specified) until one of the 
following occurs:
• It reaches the end of the tape.
• The hard disk you are importing to is full.
• You stop the import session by clicking Stop Import or Close (to close the Media 
Import window).
The video plays as it’s being imported. It takes as long to import the video as it takes to watch it 
at normal speed.
9 When the section of video you want to import has been imported, click Stop Import. Then use 
the import controls to set your video to a point where you want to begin importing again, 
and repeat steps 5 through 7. If you selected any options in step 6, Final Cut Pro transcodes 
and optimizes the files after the import process is complete. You can view the progress of the 
background tasks in the Background Tasks window.
10 When you’re done importing, click Close to close the Media Import window.
You can also create an archive from your tape-based device, recording everything on the tape 
from beginning to end and saving the captured clips as an archive. For more information, see 
Create and manage camera archives on page 411.
If your camera or device isn’t recognized
If you’ve connected your camera or device to your computer but the Media Import window 
doesn’t open, or Final Cut Pro can’t control your device, there are several things you can do to try 
to establish the connection.
Check your equipment and system
1 Make sure that you’re using the correct equipment configuration:
• Your camcorder or camera must be compatible with Final Cut Pro. For a list of 
compatible devices, go to the Final Cut Pro X Supported Cameras webpage at 
http://help.apple.com/finalcutpro/cameras.
• Your device must be connected properly to your computer.Chapter 3 Import media 31
• Your camcorder must be set to the correct output mode. On some camcorders, this is 
called VTR or VCR mode, but not all camcorders use the same terminology, so check the 
documentation that came with your device. On some camcorders you must set the output 
to DV mode or HDV mode, depending on whether the content is standard (DV) or high 
definition (HDV).
• If you’re connecting a tape-based camcorder to your computer, you should be using a FireWire 
cable (also called IEEE 1394, or i.LINK), not a USB cable.
See About memory cards and cables on page 40 for more information.
• If you’re importing video clips from a still camera or other flash memory device, make sure 
the file format of your video is MPEG-2, MPEG-4, or AVCHD, all of which are compatible with 
Final Cut Pro.
• If your still camera is not supported by Final Cut Pro, try importing the media as files, using a 
card slot on your Mac computer or an external card reader. 
See Import from a hard disk on page 34 for more information.
• If you’ve enabled Fast User Switching, make sure no one else is trying to use the camcorder 
from a different account at the same time.
2 If you still can’t import media after checking the items above, try the following:
• Turn the device off and on again.
• Disconnect the cable from both the device and the computer, and then reconnect it.
• Quit and then reopen Final Cut Pro.
• Restart your computer.
• Try using a different cable.
• Try using a different computer with Final Cut Pro installed.
• If you’re using a file-based camcorder, use the Finder to copy the mounted volume to a local 
disk. Then open the files in Final Cut Pro in the same way that you open an archive.
Note: When you see red frames and a yellow alert triangle in a Timeline or event, Final Cut Pro is 
alerting you that part of your project or event is missing. For more information, see Alert icons on 
page 414.
Importfrom other applications
Import from Motion
You can build and modify video effects, titles, transitions, and generators in Motion 5 for use in 
Final Cut Pro. When you save a template in Motion, it is “published” and becomes available in its 
respective media browser in Final Cut Pro. 
See the information about Final Cut Pro X templates in Motion Help at 
http://help.apple.com/motion.
For more information, see the following: 
• Create specialized versions of transitions in Motion on page 213
• Create specialized versions of the video effects in Motion on page 237
• Create specialized versions of the generators in Motion on page 241Chapter 3 Import media 32
Import from iMovie
You can import any of your existing iMovie projects and your iMovie Event Library into 
Final Cut Pro.
Note: If you want to import an iMovie trailer project, you first need to convert it to a standard 
iMovie project. For more information, choose Help in iMovie ‘11 and search for “Convert a trailer 
to a project.”
Important: iMovie projects and clips from the iMovie Event Library are not automatically 
analyzed during import because they retain their original analysis results from iMovie. You 
can override iMovie analysis by analyzing your clips in Final Cut Pro after import. For more 
information, see Analyze your media on page 47. 
Import an iMovie project
1 In Final Cut Pro, choose File > Import > iMovie Project and locate your existing iMovie project, 
typically found in the Movies folder on your hard disk.
2 Click Import.
The project opens in the Timeline and any associated events appear in the Event Library.
Import your iMovie Event Library
1 In Final Cut Pro, choose File > Import > iMovie Event Library.
2 Read the message that appears and click OK.
The events in your iMovie Event Library appear in the Final Cut Pro Event Library.
Import from iPhoto and Aperture
When you import photos and video clips from iPhoto or Aperture into Final Cut Pro, the media is 
imported using the import settings you defined in Import preferences. For more information, see 
Import from a hard disk on page 34.
Import photos and video clips from iPhoto or Aperture
1 In Final Cut Pro, do one of the following:
• Choose Window > Media Browser > Photos.
• Click the Photos button in the toolbar.Chapter 3 Import media 33
2 If necessary, navigate to the iPhoto or Aperture section of the Photos Browser.
3 To use one or more photos or video clips in your project, drag the items from the Photos Browser 
to an event icon in the Event Library or a project in the Timeline. To select multiple clips, you can 
Command-click them or drag a selection rectangle around them.
You can also drag photos and video clips from iPhoto or Aperture directly to an event in the 
Event Library or a project in the Timeline, without using the Photos Browser.
Import from iTunes
You can import music and sound from your existing iTunes library into Final Cut Pro.
Import music and sound from iTunes
1 In Final Cut Pro, do one of the following:
• Choose Window > Media Browser > Music and Sound.
• Click the Music and Sound button in the toolbar.
2 In the Music and Sound Browser, choose iTunes from the pop-up menu at the top.
Tip: If the folder you’re looking for doesn’t appear, you can add it to the source list by dragging it 
from the Finder or desktop to the Music and Sound Browser.
3 In the list that appears, find the music or sound you want:
• To search for an item: Type text in the search field. To filter your search, click the Filter button 
 and choose a filter.
• To preview an item: Double-click the item, or select the item and click the Play button .
• To select more than one item: Command-click each item.
4 Drag the sound file or files to the Timeline.
Note: For better import and playback performance, Final Cut Pro automatically transcodes 
all MP3 audio files to WAV audio files and retains the original MP3 files for future use. For 
information about where to find original and transcoded media files, see Where your media and 
project files are located on page 390.Chapter 3 Import media 34
Importfrom devices
Import from a hard disk
You can import media—video, audio, still images, and graphics files—from your computer’s hard 
disk, a connected external storage device, a memory card inserted in your computer’s card slot 
or a card reader, or a network attached volume. You can import media using the Media Import 
window or by dragging files from the Finder.
When you drag media from the Finder into Final Cut Pro, the media is imported using the 
organize, transcode, and analysis settings you set in Final Cut Pro preferences. If you don’t want 
to use the Media Import window to manage your import, and if you want to always use the 
same organize, transcode, and analysis settings, importing by dragging files into Final Cut Pro is a 
good option. See Import preferences on page 420 for information on the Import preferences.
Note: Some file-based devices allow you to copy the recorded media (with its original directory 
structure) to a folder on your computer’s hard disk via the Finder. To import media copied in this 
way, see Access media on an archive or disk image on page 36.
Import media from a hard disk using the Media Import window
1 If the media you want to import is on an external storage device or memory card, connect the 
device to your computer and turn it on.
2 To open the Media Import window, do one of the following:
• Choose File > Import > Media (or press Command-I).
• Click the Import Media button on the left end of the toolbar.
3 In the Devices section on the left side of the Media Import window, select your computer’s 
hard disk or the connected external storage device or memory card from which you want to 
import media.
4 Use the list view at the bottom of the window to navigate to a file or folder and select it. (When 
you import from a hard disk, filmstrips are visible for individual selected clips only.)Chapter 3 Import media 35
Tip: Command-click to select multiple files or folders to import.
Add favorite import folders.
Navigate to the files and folders.
Play back the 
selected clip.
Skim the 
selected clip.
Click a column 
heading to sort 
items by that 
category.
5 Do any of the following:
• To preview the selected clip: Play it using the playback controls or skim it by moving the pointer 
forward or backward over the filmstrip.
• To change which hard disk to import from: Select the hard disk in the Devices section or select 
the location in the Favorites section.
• To sort clips in list view by data such as duration, creation date, rating, keyword, and so on: Click 
the column headings at the top of list view.
• To add folders of frequently used media to the Favorites section: Drag a folder from the list on the 
right to the Favorites section on the left.
To remove a folder from the Favorites section, Control-click the folder and choose Remove 
from Sidebar in the shortcut menu.
• To automatically close the Media Import window when the import begins: Select the “Close 
window after starting import” checkbox.
• To add a folder to the list view by dragging: Drag the folder from the Finder to the list view and 
browse its contents in list view.
6 When you're ready to import, click Import Selected.
7 In the window that appears, choose how you want to organize the imported media in the 
Event Library:
• To add the imported clips to an existing event: Select “Add to existing event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field; then choose the disk where you want to store the event from the 
“Save to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
8 To have Final Cut Pro copy your media files and add them to the event folder that you specified, 
select the checkbox.Chapter 3 Import media 36
9 If you want to organize your media, create optimized or proxy media, analyze the video, or 
analyze the audio, select the relevant checkboxes.
If you don’t set Final Cut Pro to analyze your media during the import process, you can analyze it 
later (if necessary) in the Event Browser.
10 Click Import.
By default, the Media Import window closes when you click Import. You can begin working with 
your clips in the Event Browser. Final Cut Pro imports your media in the background.
If you selected any options in the previous step, Final Cut Pro starts to transcode and optimize 
the files after the import process is complete. You can view the progress of the import and other 
background tasks in the Background Tasks window. 
If you imported media from an external device and you chose to have Final Cut Pro copy the 
media files to the Final Cut Events folder (rather than just refer to them in their original location), 
you can disconnect the device when the background tasks are completed. 
Note: For information about restoring events and projects from backups, see Back up projects, 
your Project Library, and events on page 403.
Import media by dragging from the Finder
Do one of the following:
m Select a file, Command-click to select multiple files, or select a folder of files, and drag the file or 
files from the Finder to the event.
The clip or clips appear in the event.
m Select a file, Command-click to select multiple files, or select a folder of files and drag the file or 
files from the Finder to a Keyword Collection.
The clip or clips appear in the event, and the keyword is automatically added to the clip or clips.
Important: If you have the “Import folders as Keyword collections” Import preference selected, a 
Keyword Collection is created for each folder name, and the files inside the folder are assigned 
that keyword.
m Select a file or Command-click to select multiple files and drag the file or files to a project in 
the Timeline.
The clip or clips appear in the Timeline, and in the project’s default events folder.
The file or files are imported using your default import settings.
Access media on an archive or disk image
If you’ve created a camera archive, you can use the media in the archive in two ways:
• You can connect to the camera archive, making the media available to Final Cut Pro. Although 
all available camera archives are always listed in the Media Import window, you can’t use any 
of the media in an archive until you connect to the camera archive.
• You can import the media from the archive, or import media from disk images previously 
archived with the Final Cut Pro Log and Transfer window in Final Cut Pro 7 or earlier. When you 
do this, copies of the media are created on your local disk.
Note: Some file-based devices allow you to copy the recorded media (with its original directory 
structure) to a folder on your computer’s hard disk via the Finder. To import media copied in this 
way, follow the instructions below.Chapter 3 Import media 37
Import media from an archive or disk image
1 To open the Media Import window, do one of the following:
• Choose File > Import > Media (or press Command-I).
• Click the Import Media button on the left end of the toolbar.
2 Do one of the following:
• To mount a camera archive: In the Camera Archives section on the left side of the Media Import 
window, select a camera archive to connect to it.
Note: To disconnect the camera archive, click the Eject button.
Camera archive
• To mount a disk image: In the Devices section on the left side of the Media Import window, 
select your computer’s hard disk or the connected external storage device or memory card 
from which you want to import media. Then use the list at the bottom of the window to 
navigate to the disk image and select it. 
The archive (or disk image) is connected to Final Cut Pro and its media is displayed in the Media 
Import window.
3 To import the media, see Import from file-based cameras on page 20.
Organize files while importing
You can choose how to organize your media when you import it into Final Cut Pro.
• Copy files to Final Cut Events folder: This option duplicates the media files and places the copy 
in the Final Cut Events folder on your computer. If you’re importing media from a different disk 
or volume, or if you want to keep a copy of all the media files that have been imported into 
Final Cut Pro in the same location (in the Final Cut Events folder), select this checkbox.
If you import files with this checkbox deselected, Final Cut Pro creates reference files (file 
aliases) that simply point to the source media files without copying them. When you back 
up events and projects that use these files, Final Cut Pro copies the reference files only (not 
the source media files). If, after you back up your project or event, you want to replace the 
reference files with the actual source media files, select the events and choose File > Organize 
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• Import folders as Keyword Collections: If you have folders of files that have meaningful folder 
names, selecting this option creates a keyword for each folder name and applies the keyword 
to all the files in the folder during import. Additionally, a Keyword Collection is created for 
each keyword. 
After import, these clips 
will have “B-roll” and 
“Callaway” keywords.
After import, these clips 
will have “Interviews” and 
“Callaway” keywords.
Organize your files during import
1 To import a file, choose File > Import > Files and navigate to the file you want to import.
2 In the window that appears, choose how you want to organize the imported media in the 
Event Library:
• To add the imported media to an existing event: Select “Add to existing event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field; then choose the disk where you want to store the event from the 
“Save to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
3 Select one or both of the organize options (explained above).
4 If you want to transcode your media, analyze the video, or analyze the audio, select the 
relevant checkboxes.
If you don’t set Final Cut Pro to analyze your media during the import process, you can analyze it 
later (if necessary) in the Event Browser.
5 Click Import.
Final Cut Pro imports your media in the background. If you selected any options in the previous 
step, Final Cut Pro transcodes and optimizes the files after the import process is complete. You 
can view the progress of the background tasks in the Background Tasks window.
6 To begin working with your clips, close the Media Import window so that you can access the 
Event Browser.
Copy all external media files used by an event to its event folder
1 Select the event in the Event Library.
2 Choose File > Organize Event Files.
3 In the window that appears, click Continue.
Final Cut Pro duplicates the media files and places the copy in the Final Cut Events folder on 
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Import while recording
You can record video directly into Final Cut Pro using your computer’s built-in camera or an 
external iSight camera.
Record live video and audio into Final Cut Pro
1 Do one of the following:
• To record using the built-in camera: Click the Import Media button in the toolbar.
• To record using an external iSight camera: Connect the iSight camera to your computer with a 
FireWire cable, and click the Import Media button in the toolbar.
2 In the Cameras list on the left side of the Media Import window, select the camera you want to 
import from.
A live video image from the camera appears in the Media Import window.
3 Click Import.
The Event Settings window appears.
4 Choose how you want to organize the imported media in the Event Library:
• To add the imported media to an existing event: Select “Add to existing event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field; then choose the disk where you want to store the event from the 
“Save to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
5 If you want to organize your media, create optimized or proxy media, analyze the video, or 
analyze the audio, select the relevant checkboxes.
If you don’t set Final Cut Pro to analyze your media during the import process, you can analyze it 
later (if necessary) in the Event Browser.Chapter 3 Import media 40
6 When you’re ready to begin recording, click Import.
The camera begins recording immediately.
7 When you want to stop recording, click Stop Import.
A new video clip is created. You can click Import to begin recording again. You can repeat this 
process as many times as necessary.
Tip: It’s also possible to capture live video from some video camcorders over a FireWire cable 
using QuickTime X. For more information, see QuickTime Player Help.
About memory cards and cables
To import media from your recording device to your computer, you need to remove the memory 
card from your device and insert it into either your computer or a memory card reader. You can 
also connect your device directly to your computer using the appropriate cable. Then you can 
import the media on the memory card or device using the Media Import window. For more 
information, see Import from a hard disk on page 34 and Import from file-based cameras on 
page 20.
• Memory cards: Many file-based camcorders and devices record media on a removable memory 
card. You can connect a card reader to your computer and use that to transfer the contents of 
your memory card onto your computer. Some Mac computers feature an SD (Secure Digital) 
or SDXC (SD extended capacity) card slot that allows these computers to read and write data 
to SD media inserted in the slot. If your Mac has a card slot, you can remove the card from the 
camera, insert the card into your Mac, and then import the files.
For more information, go to http://support.apple.com/kb/ht3553.
You can also connect your device to the computer using a FireWire or USB cable. The kind of 
cable you need depends on the kind of device you’re using:
• USB device: You use a USB cable for file-based camcorders, digital still cameras that record 
video, and iPhone, iPad, and iPod touch. The USB cable should have at least one connector 
that plugs into your Mac (at the top in the illustration below). The other end of the USB 
cable, which plugs into your recording device, might look different (on the bottom in the 
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• FireWire device: For most camcorders that record to tape, you use a FireWire cable with a 6-pin 
connector on one end that plugs into your Mac (at the top in the illustration below) and 
a 4-pin connector on the other end that plugs into your camcorder (on the bottom in the 
illustration below).
Or you might have a FireWire 800 cable, with a different end that plugs into your camcorder 
or computer.
• Thunderbolt device: Devices that use Thunderbolt I/O technology use a connector that plugs 
into the mini display port on your Mac and looks like the connector below.
If your device didn’t come with a cable and you’re not sure what kind of device you have, you 
can check the logo near the cable ports on your device to see if it matches the USB or FireWire 
logo, both shown above. Otherwise, check the documentation that came with your device.
Note: Not all Mac computers include a FireWire port. Check your system configuration to confirm 
that your Mac includes FireWire support before attempting to connect a standard (DV) or 
HDV camcorder.
To check whether your camera is compatible with Final Cut Pro, go to the Final Cut Pro X 
Supported Cameras webpage at http://help.apple.com/finalcutpro/cameras.
Supported media formats
You can import and work with the following video, audio, and still-image formats in Final Cut Pro:
Video formats
• Apple Animation codec
• Apple Intermediate codec
• Apple ProRes (all versions)
• AVC-Intra
• AVCHD (including AVCCAM, AVCHD Lite, and NXCAM)
• DV (including DVCAM, DVCPRO, and DVCPRO50)
• DVCPRO HD
• H.264
• HDV
• iFrame
• Motion JPEG (OpenDML only)Chapter 3 Import media 42
• MPEG IMX (D-10)
• REDCODE RAW (R3D)
• Uncompressed 10-bit 4:2:2
• Uncompressed 8-bit 4:2:2
• XAVC
• XDCAM HD/EX/HD422
• QuickTime formats
Audio formats
• AAC
• AIFF
• BWF
• CAF
• MP3
• MP4
• WAV
Still-image formats
• BMP
• GIF
• JPEG
• PNG
• PSD (static and layered)
• RAW
• TGA
• TIFF
Container formats
• 3GP
• AVI
• MP4
• MXF
• QuickTimeChapter 3 Import media 43
Import and adjust REDCODE RAW video files
You can import and work with REDCODE RAW (R3D) files in Final Cut Pro.
RAW format video files require some additional steps before and after import.
After the R3D RAW files are imported, you can make nondestructive color correction adjustments 
directly within Final Cut Pro.
Import REDCODE RAW (R3D) files
1 Install the appropriate plug-in.
In order for Final Cut Pro to recognize the R3D RAW files, you must download and install the 
corresponding plug-in. For more information, go to http://www.red.com.
2 Import the media.
Important: When you import the media, make sure to deselect the “Create optimized media” 
and “Create proxy media” options, because any transcoding work done during import will be 
discarded if you adjust the RAW settings in the next step.
For more information about importing media, see Import from file-based cameras on page 20
and Import from a hard disk on page 34. For more information about transcoding media, see 
Transcode media files on page 397.
Note: If you are importing files from the RED ONE camera, it is recommended that you import 
the R3D RAW files only. The RED ONE camera typically generates a set of up to four QuickTime 
reference movie (.mov) files for each R3D RAW file. If you select both the R3D file and the 
reference movies during the import process, Final Cut Pro imports the R3D file only. If you need 
to import a reference movie, select only the reference movie, not the R3D file. 
3 Adjust the RAW settings (with Final Cut Pro or with an external application such as 
REDCINE–X PRO).
You can apply a nondestructive “one-light” color correction to the R3D RAW clips immediately 
after import, to give your footage a more finished look for editing and review. 
If you have a professional production with sophisticated color correction needs, you can revisit 
these RAW settings during the finishing stage. For more information, see “Adjust RED RAW 
settings,” below.
4 If you like, generate optimized or proxy media from the R3D RAW files.
For more information, see “Transcode clips after import” in Transcode media files on page 397.
Note: If you do generate optimized or proxy media, be sure to set Final Cut Pro preferences 
accordingly. For more information, see Playback preferences on page 419.
5 Add the R3D RAW clips to your project and edit as you would any other clips.Chapter 3 Import media 44
Adjust RED RAW settings
You can adjust REDCODE RAW (R3D) files using the RED RAW Settings window.
Metadata about REDCODE RAW (R3D) files can be stored in two locations:
• Internal (embedded) settings: This is metadata information recorded by the camera and 
embedded in the R3D RAW file. It always remains with the file. These camera settings can be 
superseded by settings in the external RMD file, but they are never overwritten. You can revert 
to these camera settings by deleting any existing RMD file or by choosing Original Camera 
Settings from the Revert To pop-up menu in the RED RAW Settings window.
• External RMD file: This is an external metadata file with the file extension .RMD. This file is 
created by Final Cut Pro, REDCINE-X PRO, or similar software applications. If you adjust RED 
RAW settings in Final Cut Pro and an RMD file already exists, the existing file is overwritten 
when the changes are saved. The embedded camera settings remain intact.
1 Install the appropriate plug-in.
In order for Final Cut Pro to recognize the R3D RAW files, you must download and install the 
corresponding plug-in. For more information, go to http://www.red.com.
2 In the Event Browser or the Timeline, select the clip or clips you want to adjust. 
Note: Compound clips cannot be adjusted.
3 Do one of the following:
• Choose Window > Show Inspector (or press Command-4).
• Click the Inspector button in the toolbar.
4 Click the Info button at the top of the pane that appears.
5 In the Info inspector, click the Modify RED RAW Settings button.
If the Modify RED RAW Settings button does not appear, choose Show File Status from the Action 
pop-up menu at the bottom of the Info inspector.
6 In the RED RAW Settings window, adjust the settings.
Your changes are saved nondestructively to an external metadata file with the file extension 
.RMD, overwriting any existing RMD metadata file. Unlike video effects that are applied to a clip, 
these adjustments are associated with the file (via the RMD metadata file). Any changes you 
make to these settings are applied to all copies of the selected clip or clips.
Note: Final Cut Pro supports the RED ROCKET card, a PCI card that provides a significant boost 
in performance.
For more information about REDCODE RAW (R3D) files and the RED ROCKET card, go to 
http://www.red.com.45
Analyzing media overview
You can have Final Cut Pro analyze your media and automatically correct common problems 
it may find in your video, still images, and audio. For example, you can stabilize shaky video, 
balance color, and remove excess hum or loudness.
You can also analyze clips to identify their contents. Analysis can detect the number of people in 
a shot and identify if the shot is a close-up, medium, or wide shot. This is helpful if you need to 
quickly find a certain type of clip while viewing footage or editing a project. For complete lists of 
the video and audio analysis options, see Video and still-image analysis options on page 45 and 
Audio analysis options on page 46.
You can analyze media during the import process or after you import the media into 
Final Cut Pro. You can also set Final Cut Pro to automatically analyze clips you drag directly to the 
Final Cut Pro Timeline from the Finder.
After certain types of analysis, keywords are automatically added to clips or clip ranges to 
describe the results of the analysis. For example, a clip range with shaky video is assigned the 
Excessive Shake keyword. In the Event Browser, clips with analysis keywords have a purple line at 
the top. (Clips with keywords you add manually have a blue line at the top. For more information, 
see Add keywords to clips on page 64.)
Video and still-image analysis options
Final Cut Pro provides automatic video and still-image analysis options that can find and 
correct shaky video, automatically balance color in video, and detect people and shot angles in 
video or still images. You can analyze video during import, or analyze video clips in the Event 
Browser after import. Analysis keywords are added to clips or clip ranges based on the results of 
the analysis.
Final Cut Pro provides these video and still-image analysis options:
• Analyze for stabilization and rolling shutter: Analyzes video clips and adds the Excessive Shake 
analysis keyword to clips or clip ranges with excessive shake, rolling shutter, or both. If a clip 
has an Excessive Shake keyword, you can fix the shaking after you add the clip to the Timeline 
by turning on Stabilization and Rolling Shutter corrections. See Correct excessive shake and 
rolling shutter issues on page 154. If a clip doesn’t have stabilization-related issues, the Steady 
Shot analysis keyword is added.
Note: If you’re analyzing for stabilization problems, it’s recommended that you also select the 
“Create Smart Collections after analysis” checkbox so that you can easily locate clips with the 
Excessive Shake keyword.
Important: Analysis for stabilization and rolling shutter is available only after import. For more 
information, see Analyze your media on page 47.
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• Analyze for balance color: Analyzes video clips to detect color balance and contrast. Color is 
automatically balanced when you add the clip to the Timeline. You can turn automatic color 
adjustments on and off at any time.
• Remove pulldown: Analyzes video clips and removes pulldown patterns.
Important: This option is available only when importing from a tape-based camera or device.
• Find people: Analyzes video clips and still images for the number of people present and shot 
types. After analysis, any of the following keywords are added to the clips or clip ranges: One 
Person, Two Persons, Group, Close Up Shot, Medium Shot, and Wide Shot.
Note: If you’re analyzing to find people, it’s recommended that you also select the “Create 
Smart Collections after analysis” checkbox so that you can easily locate clips with “find people” 
analysis keywords.
• Consolidate find people results: Consolidates all of the “find people” analysis keywords into one 
shot type keyword and one people keyword for every 2-minute segment of video. The shot 
type keyword chosen is the one for the widest shot type, and the people keyword chosen is 
the one representing the most people. For example, if a video segment contains Medium Shot, 
Wide Shot, One Person, and Group keywords, the segment's analysis keywords are reduced to 
Wide Shot and Group during consolidation.
• Create Smart Collections after analysis: Creates a Smart Collection for each keyword applied 
when analyzing video clips for image stabilization problems or analyzing video clips and still 
images for the presence of people. The Smart Collections are listed alphabetically in a People 
folder inside the event in the Event Library.
When you drag a media file from the Finder to a Final Cut Pro event or the Timeline, the import 
begins automatically, without displaying a window of import options. You can set automatic 
import options in the Final Cut Pro Import preferences pane.
Audio analysis options
Final Cut Pro provides automatic analysis options that can fix common audio problems, analyze 
and group audio channels, and remove silent channels. You can analyze audio during import, or 
analyze video clips with audio issues in the Event Browser or in the Timeline. 
Final Cut Pro provides these audio analysis options:
• Analyze and fix audio problems: Analyzes the audio for hum, noise, and loudness. Final Cut Pro 
automatically fixes problems that are considered severe (marked in red) and flags problems 
that are considered moderate (marked in yellow). For more information, see Enhance audio on 
page 199.
• Separate mono and group stereo audio: Audio channels are analyzed and grouped as dual 
mono or stereo, depending on the results of the analysis. Automatically corrected audio 
channels are marked as Autoselected. For more information about audio channels, see 
Configure audio channels on page 169.
• Remove silent channels: Audio channels are analyzed, and silent channels are automatically 
removed. Clips that have had channels removed are marked as Autoselected. For more 
information about audio channels, see Configure audio channels on page 169.
When you drag a media file from the Finder to a Final Cut Pro event or the Timeline, the import 
begins automatically, without displaying a window of import options. You can set automatic 
import options in the Final Cut Pro Import preferences pane.Chapter 4 Analyze media 47
Analyze your media
You can analyze clips during the import process, analyze clips in the Event Browser after import, 
or set Final Cut Pro to analyze clips automatically when they are dragged to a Final Cut Pro event 
or the Timeline.
Note: Analysis for stabilization and rolling shutter is available only after import.
Analyze clips during import
1 Do one of the following:
• To import a file from a compatible camcorder or camera, iPad, iPhone, iPod, or other device: 
Connect the device to your computer, turn on the device, and choose File > Import > Media 
(or press Command-I). In the window that appears, select the file you want to import, and click 
the Import button.
• To import a file from a tape-based camcorder: Connect the camcorder to your computer, turn 
on the camcorder, and set it to VTR or VCR mode. Then choose File > Import > Media (or press 
Command-I) and click the Import button.
• To import a file from a memory card: Insert the memory card into the card slot on your Mac or 
into a card reader that’s connected to your computer, and choose File > Import > Media (or 
press Command-I). In the window that appears, select the file you want to import, and click 
the Import button.
• To import a file located on your hard disk or a connected external storage device: Choose File > 
Import > Media (or press Command-I). In the window that appears, select the file you want to 
import, and click the Import button.
• To import from an archive: Choose File > Import > Media (or press Command-I). In the window 
that appears, select a camera archive from the list on the left, click Open Archive, select the 
files you want to import, and click the Import button.
2 In the window that appears, choose how you want to organize the imported media in the 
Event Library:
• To add the imported media to an existing event: Select “Add to existing Event,” and choose the 
event from the pop-up menu.
• To create a new event: Select “Create new Event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field. Use the “Save to” pop-up menu to choose the disk where you want 
to store the event.
To learn more about events, see Events and clips overview on page 51.
3 Select any of the video and audio analysis options that you want to apply.
For descriptions of the video and audio analysis options, see Video and still-image analysis 
options on page 45 and Audio analysis options on page 46.
Final Cut Pro will analyze the files in the background, after the import process is complete.
4 Click Import.
The import may take a while, depending on the options you selected in step 3. You can see the 
status of all the background processes currently running in the Background Tasks window.Chapter 4 Analyze media 48
Analyze clips after import
1 In the Event Browser, Control-click one or more clips and choose “Analyze and Fix” from the 
shortcut menu.
Tip: To quickly find a clip used in the Timeline, Control-click the clip and choose “Reveal in Event 
Browser” from the shortcut menu.
2 In the window that appears, select any or all of the video analysis and audio analysis options that 
you want to apply, and click OK.
The transcoding process may take a while, depending on the analysis options you selected. 
You can see the status of all the background processes currently running in the Background 
Tasks window.
Automatically analyze media files when they are dragged to an event or the Timeline
1 Choose Final Cut Pro > Preferences.
2 In the Preferences window, click Import and select each of the video and audio analysis options 
that you want to apply.
When you’re finished, close the Preferences window.
3 To import one or more files, select a file (or Command-click multiple files) in the Finder and drag 
the selection to an event or the Timeline.
View analysis keywords on clips
If you analyzed media to find shaky footage or people, analysis keywords such as Excessive 
Shake, One Person, Close Up Shot, and so on are automatically added to clips or clip ranges. 
Clips or ranges with analysis keywords are marked with a purple line in the Event Browser. 
A clip with a purple 
line has one or more 
analysis keywords.
You can view a clip’s analysis keywords in several locations in Final Cut Pro.Chapter 4 Analyze media 49
View keywords in the Skimmer Info window
1 Choose View > Show Skimmer Info (or press Control-Y).
2 Skim the clip in the Event Browser.
Keywords, including analysis keywords, are displayed in the Skimmer Info window when you 
hold the pointer over the clip.
To turn off Skimmer Info, choose View > Hide Skimmer Info (or press Control-Y). 
View keywords in list view in the Event Browser
1 Click the List View button.
2 To see a clip’s keywords, click the disclosure triangle next to the clip.
The analysis keywords are 
listed next to the purple gear.Chapter 4 Analyze media 50
View the contents of a Smart Collection
If you chose to create Smart Collections after analysis, clips that have analysis keywords are 
automatically grouped in Smart Collections within the event in the Event Library. A Smart 
Collection is created for each analysis keyword and placed in either a People folder or a 
Stabilization folder, depending on the type of analysis. 
m In the Event Library, select an analysis keyword Smart Collection inside a People folder or 
Stabilization folder in an event.
The clips with that analysis keyword appear in the Event Browser. For example, if you select the 
Medium Shot Smart Collection, all the clips in the event that have the Medium Shot keyword 
appear in the Event Browser.
Medium Shot Smart Collection
These clips contain the 
Medium Shot analysis keyword.51
Events and clips overview
When you import video, audio, and still images, or record directly into Final Cut Pro, the source 
media files (your raw footage) appear as clips in one or more events in the Event Library. An 
event is similar to a folder that can hold dozens, hundreds, or even thousands of video clips, 
audio clips, and still images. Each event in the Event Library refers to a folder on your hard 
disk that contains the original source media files, any render files related to your media, and a 
database file that keeps track of where everything is.
When you select an event in the Event Library, the media it contains appears as clips in the Event 
Browser. You select clips or portions of clips in the Event Browser to work with them. You can sort 
clips in the Event Browser by creation date, as well as by date imported, reel, scene, clip duration, 
and file type.
Select an event 
in the Event Library.
The Event Browser displays 
the clips in the selected event.
When you import video into a new event, you name the event. By giving your events meaningful 
names, such as “Smith Wedding 2011,” you can organize all of your media so that it’s readily 
accessible. By default, Final Cut Pro lists the events in the Event Library by the date they were 
recorded. You can organize the Event Library in other ways, and you can also hide the Event 
Library to give yourself more room to work. The Event Library is also the home for Final Cut Pro 
Keyword Collections and Smart Collections which provide a powerful way to organize your video 
editing projects using keywords and persistent search filters.
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Organize events
Create a new event
After importing your source media files into Final Cut Pro, you may find that you need to create 
additional events to organize your media. For example, after importing media shot for a specific 
client, you may decide to split the media into events defined by the location the media was shot 
in; or split the media by the time of day it was shot, such as morning, afternoon, and evening.
Create a new event in the Event Library
1 If you don’t see the Event Library, click the Event Library button at the bottom-left corner of the 
Event Browser.
2 Choose File > New Event (or press Option-N).
A new event appears in the Event Library.
3 Type a name for the event and press Return.
4 Move clips from other events into the new event, as necessary.
Rename an event
Change an event’s name
As your project evolves, you may find that you want to rename an event so that it more 
accurately reflects the clips it contains.
1 In the Event Library, select the event whose name you want to change.
2 Do one of the following:
• Click the event’s name and type a new name.
• Press Return and type a new name.
Important: Renaming an event also renames the event’s folder on the hard disk where your 
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Merge or split events
You can merge (combine) two or more events in the Event Library (for example, if the media they 
contain is very closely related). You can also split a single event into multiple events if you find an 
event is getting unmanageable.
Merge multiple events
1 In the Event Library, do one of the following:
• Drag one or more events that you want to combine to a new event.
• Select the events you want to combine, and choose File > Merge Events.
2 In the Merge Events window that appears, type a new name for the event.
3 Choose the disk where you want to store the event’s source media files from the Location 
pop-up menu, and click OK.
Final Cut Pro merges the selected events into a single event in the Event Library. The source 
media files for all the clips are moved into the merged event folder on the hard disk and stored 
in the location you chose from the pop-up menu.
Split an event into multiple events
1 Create the new events you need.
2 Move the clips you want to separate out from the original event to the new events.
The source media files for all the clips are moved into the event folders on disk corresponding to 
the newly created events in the Event Library.
Important: If you disconnect the disk where your merged or split events are stored, you will 
not be able to access the events or their source media files from within Final Cut Pro until you 
reconnect the disk.
Copy or move clips between events
You can copy and move clips from one event to another. When you copy a clip from one event 
to another, the corresponding file is duplicated on disk. When you move a clip from one event to 
another, the corresponding file is moved from one event folder to the other on disk.
Note: When you import media into Final Cut Pro, you have the option to select the “Copy files 
to Final Cut Events folder” checkbox, which duplicates the source media files on your hard disk. 
If you import files with this checkbox deselected, Final Cut Pro creates reference files (aliases) 
that simply point to the source media files without copying them. When you copy or move 
clips between events, Final Cut Pro copies or moves the reference files only (not the source 
media files). If, after you have copied or moved the clips, you want to replace the corresponding 
reference files with the actual source media files, select the events and choose File > Organize 
Event Files. For more information about files and clips, see Media files and clips on page 17.Chapter 5 Organize your media 54
Copy clips from one event to another
1 In the Event Library, select the event that contains the clips you want to copy.
2 In the Event Browser, select the clip or clips you want to copy.
3 Do one of the following:
• If both events are on the same hard disk: Option-drag the clips from one event to the other by 
first starting to drag and then holding down the Option key as you drag.
• If the events are on separate hard disks: Drag the clips from one event to the other.
Move clips from one event to another
1 In the Event Library, select the event that contains the clips you want to move.
2 In the Event Browser, select the clip or clips you want to move.
3 Do one of the following:
• If both events are on the same hard disk: Drag the clips from one event to the other.
• If the events are on separate hard disks: Command-drag the clips from one event to the other.
The event to which you copy or move the clips may be re-sorted in the Event Library. It will be 
listed below the year in which its most recent clip was recorded.
If you copy or move a large clip from an event stored on one hard disk to an event stored on 
another, the move may take a few minutes as the source media files are copied or moved from 
disk to disk.
Copy or move events
You can easily copy or move an event from your computer to a hard disk or from one hard disk 
to another. This is useful if you want to work with your event on another computer that has 
Final Cut Pro installed or free up space on your computer’s hard disk.
Copy an event
1 Make sure another hard disk is connected to your computer.
2 Choose Group Events by Disk from the Action pop-up menu below the Event Library.
The connected disk drive’s icon and name appear in the Event Library.
3 Select an event in the Event Library.
4 Do one of the following: 
• Choose File > Duplicate Event (or press Command-D).
• Drag the event to the external drive’s icon.
5 In the Duplicate Event window, type a name for the new event.
6 To store your files in a second location, choose it from the Location pop-up menu.
7 Click OK.
Final Cut Pro makes a copy of the event at the location you chose. It also makes copies of the 
source media files and places them in a new event folder. Keep in mind that copying an event 
with large source media files can take several minutes.Chapter 5 Organize your media 55
Move an event
1 Make sure another hard disk is connected to your computer.
2 Choose Group Events by Disk from the Action pop-up menu below the Event Library.
The connected disk drive’s icon and name appear in the Event Library.
3 Select an event in the Event Library.
4 Do one of the following: 
• Choose File > Move Event.
• Command-drag the event to the drive’s icon.
5 To store your files in a second location, choose it from the Location pop-up menu.
6 Click OK.
Final Cut Pro moves the event to the location you chose. It also moves the event folder that 
contains the source media files. Keep in mind that moving an event with large source media files 
can take several minutes.
Important: If you disconnect the disk containing the event you moved, you will no longer 
have access to the event or its source media files from within Final Cut Pro until you reconnect 
the disk.
Sort events
In the Event Library, you can view your events in a number of ways, including by the disk they’re 
stored on and the date when they were recorded.
Sort events by storage location or date
m To view events by the hard disk where they’re stored: Choose Group Events by Disk from the Action 
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m To view events by the date they were recorded: Choose Group Events by Date from the Action 
pop-up menu, and choose an option from the submenu.
Show event date ranges
Final Cut Pro can display the date ranges for the source media files within each event.
m Choose Show Date Ranges in Event Library from the Action pop-up menu .
Sort events by most recent
m Choose Arrange Events by Most Recent from the Action pop-up menu .
Delete clips or events
You can delete unwanted clips from an event, and you can delete an entire event in order 
to free up space on your hard disk. When you delete a clip from an event or an entire event, 
Final Cut Pro moves the source media to the Trash.
Note: The Event Library must contain at least one event.
Delete clips from an event or an entire event
1 In the Event Library, select the event you want to delete or delete clips from.
2 Do either of the following:
• To delete clips from the event: Select the clips you want to remove, and choose File > Move to 
Trash (or press Command-Delete).
• To delete the entire event: Choose File > Move Event to Trash (or press Command-Delete).Chapter 5 Organize your media 57
The selected clips’ source media files, or the event and all its associated source media files, are 
moved to the Finder Trash. To permanently delete the source media files from your hard disk, 
empty the Trash.
WARNING: After the Trash is emptied, the deleted clips or event and all their source media files 
cannot be restored.
Organize clips
View and sort clips
You can display your clips in the Event Browser in two views:
• Filmstrip view: Displays the clips in the selected event as a connected series of thumbnail 
images. Filmstrip view is useful when you want to visually locate your clips.
• List view: Displays a list of your clips with associated file information. Use this view when you 
want to view or sort clips by data such as duration, creation date, rating, keyword, and so on. 
When you select a clip in list view, a filmstrip for the selected clip appears at the top of the 
Event Browser. The filmstrip is fully interactive, allowing access to start and end points, markers, 
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Switch between filmstrip and list views
Do one of the following:
m Click the Filmstrip View button in the bottom-left corner of the Event Browser.
m Click the List View button in the bottom-left corner of the Event Browser.
Customize filmstrip view
m To adjust the time represented by each thumbnail in a clip’s filmstrip: At the bottom-right corner of 
the Event Browser, drag the Duration slider.
Slider set to 5 seconds
Slider set to 30 seconds
Adjusting the Duration slider expands and contracts the amount of detail shown in each clip’s 
filmstrip. The longer each thumbnail’s duration, the fewer thumbnails each clip displays, and the 
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m To adjust the filmstrip height: At the bottom-right corner of the Event Browser, click the Clip 
Appearance button and drag the Clip Height slider.
m To turn audio waveforms on and off: At the bottom-right corner of the Event Browser, click the Clip 
Appearance button and deselect the Show Waveforms checkbox in the window that appears.
When audio waveforms are on, they appear at the bottom of each clip’s filmstrip, increasing the 
height of all clips in the Event Browser.Chapter 5 Organize your media 60
Customize list view
m To choose what type of information is displayed in list view columns as well as customize the columns 
themselves: In the Event Browser, Control-click a column heading, and choose a category option 
from the shortcut menu.
m To rearrange columns in list view: In the Event Browser, drag a column heading to move the 
column to a new position.
m To sort clips in list view by a category: Click a column heading in the Event Browser to sort clips by 
that category.
m To view a clip’s rating and keywords in list view: Click the disclosure triangle to the left of the 
clip’s name.
Keyword
Rating
If a disclosure triangle appears to the left of a clip in list view, it means a rating, keyword, or both 
have been applied to that clip.
Sort clips in the Event Browser
You can sort clips in the Event Browser into an order that makes it easier to visually locate them.
1 In the Event Library, select the event whose clips you want to sort.
2 Do one or both of the following:
• To group clips by category: Choose Group Clips By from the Action pop-up menu below 
the Event Library, and choose a category from the submenu. Choose to set the sort order as 
Ascending or Descending from the same submenu.
• To set the sort order of the clips in the event without grouping them: Choose Arrange Clips 
By from the Action pop-up menu below the Event Library, and choose a category from 
the submenu.
Note: You can both group clips and set their sort order (arrangement) independently.
Reset the sort order in the Event Browser to its default state
1 In the Event Library, select the event that contains the clips whose sort order you want to reset.
2 Choose Group Clips By > None and Group Clips By > Ascending from the Action pop-up menu 
 below the Event Library.
3 Choose Arrange Clips By > Content Created and Arrange Clips By > Ascending from the Action 
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Rename clips
You can rename clips in the Event Browser, the Timeline Index, or the Info inspector at any time.
Renaming a clip affects only that instance of the clip. For example, if you add a clip from the 
Event Browser to the Timeline, copy clips between events, or copy clips within the Timeline, each 
of these clip instances (copies) is independent of the others and can have its own name.
Important: Renaming a clip in Final Cut Pro does not rename the clip’s source media file on disk.
Rename a clip in the Event Browser
m To rename a clip in filmstrip view: Select a clip’s name, and type a new name.
m To rename a clip in list view: Select a clip’s name, press Return, and type a new name.
Rename a clip in the Timeline Index
1 To open the Timeline Index, click the Timeline Index button in the lower-left corner of the 
Final Cut Pro main window (or press Command-Shift-2).
2 Click the Clips button at the top of the Timeline Index. 
Clips button
3 Click the Name field for a clip, and type a new name.
Rename a clip in the Info inspector
1 Select a clip in the Event Browser or the Timeline.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 In the Name section of the Info inspector, click the Name field and type a new name.Chapter 5 Organize your media 62
Rate clips as Favorite or Rejected
If your clips contain sections that you don’t like or that you might never want to use in a 
project—because they’re blurry, for example—you can mark them as Rejected. You can easily 
rate the clips you like and the clips you don’t like as you review them. When you’re ready to 
make a project or play your clip for your client, you can focus on your best footage by choosing 
to display only those clips you marked as Favorite. You can also delete your rejected clips’ source 
media files to free up space on your hard disk.
Favorite Rejected
Rate clips
1 In the Event Browser, select a range, a clip, or multiple clips you want to rate.
2 Do one of the following:
• If you like the selection: Press the F key or click the Favorite button in the toolbar.
In the Event Browser, a green line appears at the top of frames you’ve marked as Favorite.
• If you don’t like the selection: Press the Delete key or click the Reject button in the toolbar.
A red line appears at the top of frames you’ve marked as Rejected.
Note: If you chose Hide Rejected from the Filter pop-up menu at the top of the Event Browser, 
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Remove ratings from clips
1 Make sure the clips you want to work with appear in the Event Browser.
You might need to choose a new option, such as All Clips, from the Filter pop-up menu at the 
top-left corner of the Event Browser so that all the clips you need to access are visible.
Choose All Clips to 
show all the clips in 
the event regardless 
of rating.
2 In the Event Browser, select the clips whose rating you want to remove, and press the U key or 
click the Clear Rating button in the toolbar.
The green or red line at the top of the clips disappears.
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Add keywords to clips
You can apply keywords to your clips to help you quickly locate the clips you need to compose 
your movie. After you apply a keyword to a clip or clip range, the clip or range is marked with 
a blue line in the Event Browser. (Clips that have analysis keywords, which are automatically 
applied after certain types of analysis, are marked with a purple line. For more information, see 
Analyzing media overview on page 45.)
Additionally, when a keyword is applied to a clip or clip range, a Keyword Collection appears in 
the Event Library. A Keyword Collection contains pointers (aliases) to clips tagged with a specific 
keyword. For example, if you apply the keyword “Nicholas” to all clips containing Nicholas, you 
can then select the Nicholas Keyword Collection in the Event Library to view all clips containing 
the “Nicholas” keyword in the Event Browser. 
Keyword 
Collections
A blue line indicates that 
a clip has keywords.
You can apply one or more keywords to a range within a clip, a whole clip, or a group of clips in 
an event.
Apply keywords using the Keyword Editor
1 In the Event Browser, select a range or one or more clips to which you want to add keywords.
2 To open the Keyword Editor, click the Keywords button in the toolbar.
3 At the top of the Keyword Editor, type the keyword or keyword phrase you want to apply to the 
selection, and press Return.
Type a keyword 
or keyword phrase, 
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4 Repeat step 3 for each keyword or keyword phrase you want added to the selection.
A blue line appears at the top of the selection in the Event Browser, indicating that keywords 
have been applied to it.
5 When you’re finished adding keywords, close the Keyword Editor.
Assign keywords using keyboard shortcuts
To add keyword phrases to your clips using keyboard shortcuts, you must first assign keywords 
and keyword phrases to the keyboard shortcuts.
1 If the Keyword Editor isn’t open, click the Keywords button in the toolbar.
2 In the Keyword Editor, click the disclosure triangle to the left of Keyword Shortcuts.
3 Type a keyword or phrase in each shortcut field, and press Return.
To reassign a keyboard shortcut, select the shortcut text in the field and type the new keyword.
Enter keywords 
or a keyword phrase 
here to assign them 
to keyboard shortcuts.
4 To use a keyboard shortcut, select a range or one or more clips to which you want to add 
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View keywords applied to clips
m To quickly identify clips that have keywords: Select an event in the Event Library. 
Clips that have one or more keywords appear in the Event Browser marked with a blue line at 
the top.
m To view all keywords applied to a clip: Choose View > Show Skimmer Info (or press Control-Y), and 
skim the clip in the Event Browser. 
You can also view a clip’s keywords by selecting the clip in the Event Browser and clicking the 
Keywords button in the toolbar. The keywords applied to the clip are shown in the Keyword Editor.
m To view all the clips that have a specific keyword: Select a Keyword Collection in the Event Library. 
The clips with that keyword appear in the Event Browser.
Remove all keywords from a selection
1 In the Event Browser, select a range or one or more clips from which you want to 
remove keywords.
A blue line at the top of the clips indicates the portions of the clips that have keywords applied.
2 Choose Mark > Remove All Keywords (or press Control-0).
Remove a subset of keywords from a selection
1 In the Event Browser, select a range or one or more clips from which you want to remove 
specific keywords.
A blue line at the top of the clips indicates the portions of the clips that have keywords applied. 
Each keyword assigned to a clip is also shown in list view.
2 Click the Keywords button in the toolbar to open the Keyword Editor, select the keyword or 
keywords you want to remove, and press Delete.
Select the keyword 
or keywords that you 
want to remove from 
the selection, and 
press Delete.Chapter 5 Organize your media 67
Add or edit clip notes
As you review your clips, you can add and edit notes about them in the Event Browser or the 
Timeline Index. You can quickly find your clips by entering the note text in the search field in 
the Event Browser or the Timeline Index, or the Text field in the Filter window.
Note: You can add notes to each instance of a clip. For example, if you add a clip from the Event 
Browser to the Timeline, copy clips between events, or copy clips within the Timeline, each of 
these clip instances (copies) is independent of the others.
Add or edit clip notes in the Event Browser
1 Click the List View button in the bottom-left corner of the Event Browser.
2 Select the clip for which you want to add or edit notes.
Note: Notes are applied to the whole clip, not to range selections.
3 Click the Notes field for the clip, and type or edit the notes for that clip.
Add or edit clip notes in the Timeline Index
1 To open the Timeline Index, click the Timeline Index button in the lower-left corner of the 
Final Cut Pro main window (or press Command-Shift-2).
2 To open the Clips pane, click the Clips button at the top of the Timeline Index. 
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3 If the Notes column is not visible in the Clips pane, Control-click a column heading and choose 
Notes from the shortcut menu.
4 Click the Notes field for the clip, and type or edit the notes for that clip.
Enter notes 
for a clip here.
Organize clips by roles
You can organize clips by roles, which are metadata text labels assigned to clips. 
When you import clips (video, audio, or still images), Final Cut Pro automatically assigns one of 
five default roles to the video and audio components of each clip: Video, Titles, Dialogue, Music, 
and Effects. You can also create custom roles and subroles and assign them to clips.
You can view and reassign roles in the Event Browser, the Timeline Index, or the Info inspector. 
For example, you could easily identify all your dialogue clips and play them back in isolation from 
other audio clips. See View and reassign roles on page 300.
Find clips in the Event Browser
In Final Cut Pro, you can search for media in two ways: 
• Quickly filter clips by marking: Use the Filter pop-up menu in the Event Browser to quickly 
locate individual clips by rating, or the absence of ratings and keywords.
• Search by a combination of criteria using the Filter window: Use the Filter window to perform 
complex searches for clips, also known as a weighted search. You can use a wide variety of 
criteria to search with, including clip name, rating, media type, excessive shake, keywords, the 
presence of people, format information, and date.Chapter 5 Organize your media 69
Filter clips quickly by rating
Use the Filter pop-up menu in the Event Browser to quickly find clips by rating.
1 In the Event Library, select one or more events you want to search.
2 Choose an option from the Filter pop-up menu at the top of the Event Browser.
• All Clips: Shows all clips in the event.
• Hide Rejected: Shows all clips or range selections except those you’ve rated Reject.
• No Ratings or Keywords: Shows only the clips or range selections without ratings or keywords.
• Favorites: Shows only the clips or range selections you’ve rated Favorite.
• Rejected: Shows only the clips or range selections you’ve rated Reject.
Search for clips by a combination of criteria
The Filter window allows you to combine multiple search criteria. For example, you can search for 
video clips that contain the text “exterior” in their metadata.
1 In the Event Library, select the event or folder you want to search.
2 Click the Filter button at the top of the Event Browser.
3 In the Filter window, choose search criteria, or rules, from the Add Rule pop-up menu.
Add Rule pop-up menu
• Text: Find clips by their name or any notes applied to them in list view using text. You can add 
multiple Text rules to search by more than one word or phrase, as well as eliminate specific 
words and phrases from the search.
• Ratings: Find clips based on the rating (Favorite or Reject) assigned to them.
• Media Type: Find clips whose source media files are of a specific type, such as video, audio, 
or stills.
• Stabilization: Find video clips that Final Cut Pro has identified as having excessive shake.
• Keywords: Find clips by any of the keywords that you’ve assigned to them. You can select one 
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• People: Find clips that Final Cut Pro has identified as having people in them.
• Format Info: Find clips using format information, such as video frame rate or scene number.
• Date: Find clips by either the date the clip’s media file was created or the date the media was 
imported into Final Cut Pro.
• Roles: Find clips by their assigned roles.
To remove a rule, click the Remove button to the right of the rule. To exclude a rule from your 
search without removing it, deselect the checkbox to the left of the rule.
4 Further refine your search by choosing items from the pop-up menus for the rules you’ve added.
5 Do one of the following:
• To specify that a clip must match at least one of the criteria or keywords: Choose Any from the 
pop-up menu in the upper-left corner of the Filter window.
• To specify that a clip must match all the criteria and keywords: Choose All from the pop-up menu.
The clips that match the search criteria are displayed in the Event Browser, and icons indicating 
the search status appear to the right of the Filter button at the top of the Event Browser.
If you wish, you can save your search results as a Smart Collection, which gathers clips 
automatically based on the search criteria.
Clear a weighted search
m Click the Reset button to the right of the search status icons in the upper-right corner of the 
Event Browser.
Tip: If clips still appear to be missing from view, make sure to choose either All Clips or Hide 
Rejected from the Filter pop-up menu in the upper-left corner of the Event Browser.
Search for clips by clip name and notes
You can use the search field to quickly find clips by name and any notes (applied in list view) 
without having to open the Filter window.
1 In the Event Library, select one or more events you want to search.
2 In the search field, enter the clip’s name or notes applied to the clip you’re looking for.
Conduct a filter and search workflow
Performing a weighted search and then filtering the clips in the Event Browser by rating is a 
powerful way to quickly find clips. This is also the best method of finding specific clips that you 
haven’t rated and comparing them against the clips you have rated.
1 In the Event Library, select the event or folder you want to search.
2 Search for clips using a combination of search criteria as described in the “Search for clips 
by a combination of criteria” steps above. However, do not apply a ratings filter using the 
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3 Use the Filter pop-up menu, as described in the “Filter clips quickly by rating” steps above, to 
quickly filter the clips by rating.
4 Repeat step 3 until you find the clips you’re looking for.
Save searches as Smart Collections
When you search for clips in an event using the Filter window, you can save your results by 
creating a new Smart Collection that gathers clips matching the search criteria. Anytime a new 
clip that matches the Smart Collection’s search criteria is brought into the event, the new clip is 
automatically added to the Smart Collection.
Clips that appear in Smart Collections are not duplicates. Smart Collections filter clips in an event 
to help you focus on the clips you need to use for a specific task.
Create a Smart Collection based on search criteria
1 In the Event Library, select an event.
2 Use the Filter window to search for clips based on specified criteria.
3 In the Filter window, click the New Smart Collection button.
A new, untitled Smart Collection appears in the Event Library.
4 Type a name for the Smart Collection, and press Return.
When you add clips to the event that match the Smart Collection’s search criteria, they’re 
automatically added to the Smart Collection.
Change the contents of a Smart Collection
1 In the Event Library, double-click the Smart Collection whose contents you want to change.
The Filter window for the Smart Collection appears.
Smart Collection
2 Revise the search criteria in the Filter window.
3 When you’re finished specifying search criteria, close the Filter window.
Note: Modifying a clip’s ratings or keywords in such a way that it no longer matches a Smart 
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Delete a Smart Collection
m In the Event Library, select the Smart Collection you want to delete, and choose File > Delete 
Smart Collection (or press Command-Delete).
The Smart Collection is removed from the Event Library, but its associated clips (the clips that 
appeared in it) are unaffected.
Organize Keyword and Smart Collections
You can organize Keyword Collections and Smart Collections in the Event Library with folders.
Organize collections with folders
1 In the Event Library, select the event containing the collections you want to organize, and choose 
File > New Folder.
2 Type a name for the new folder that appears within the event.
3 Select the Smart Collections and Keyword Collections you want to organize, and drag them into 
the new folder.
You can show and hide the contents of the folder by clicking the disclosure triangle to the left of 
the folder’s name.73
Playback and skimming overview
Final Cut Pro makes it easy to view and listen to your media, whether it’s located in the Event 
Browser, the Project Library, or the Timeline. Its dynamic previewing capabilities let you find what 
you need quickly without being distracted from the task at hand.
You use two tools to preview and play back media in Final Cut Pro:
• The playhead marks the current position in the Timeline or the Event Browser. You can move 
the playhead by dragging it or clicking another area of the Timeline or Event Browser. You use 
the playhead to scrub, or play back from its current position.
The playhead appears as a gray vertical line that is fixed in place unless you move it or 
click elsewhere.
• The skimmer lets you preview clips in the Timeline, Event Browser, or Project Library, without 
affecting the playhead position. You use the skimmer to skim, or freely move over clips to play 
back at the position and speed of the pointer.
The skimmer appears as a pink vertical line as you move the pointer over the area you’re 
skimming. If you have snapping turned on, the skimmer turns orange when it snaps to 
a position.
Playhead Playhead
Skimmer
Skimmer
When skimming is turned on, you can skim to see what’s in other clips, but still keep your 
playhead position in the Timeline. If both the playhead and skimmer are present in the same clip, 
the skimmer becomes the default position for playback or editing.
When skimming is turned off or the skimmer is not present in a clip, the playhead assumes the 
default position.
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Play back media
You can play back projects and clips in Final Cut Pro. Playback options include playing from the 
beginning, playing from a certain point, looping playback, and playing at different speeds. You 
can also play back video in full-screen view. 
Whether Final Cut Pro uses proxy media or your original or optimized media during playback 
is determined by the playback setting you select in the Final Cut Pro Editing preferences. See 
Playback preferences on page 419 for more information.
Play back video and audio clips
m To play a project or clip from the beginning: Select the project or clip and choose 
View > Playback > Play from Beginning (or press Shift-Control-I).
m To play a section of a project, selected clips, or a frame range from the beginning: Select the 
project, clips, or all or part of a clip, and choose View > Playback > Play Selection, or press 
the Slash (/) key.
When you select a clip or a portion of a clip or project, the selected area is marked with a 
yellow border.
Yellow border
m To play a project or clip from a specific point: In the Event Browser or the Timeline, click a point in 
a project or within a clip where you want to begin (or move the playhead to the point in the 
Timeline), and either press the Space bar or click the Play button in the Viewer (or press L).
The clip or project begins 
playing at the skimmer 
or playhead position.
m To play around the playhead or skimmer: Choose View > Playback > Play Around, or press ShiftQuestion Mark (?).
Skimmer
m To stop playback: Press the Space bar.Chapter 6 Play back and skim media 75
Use the J, K, and L keys for playback
You can use the J, K, and L keys on your keyboard to play through a project or clip. Playback 
begins at the location of the playhead (on a project) or the skimmer (on a clip). You can also use 
the J, K, and L keys to control a video playback device.
Moves through
forward speeds
Moves through
reverse speeds
Pause
You can use these keys to speed playback up to 32x normal speed.
m To begin forward playback at normal (1x) speed: Press L.
m To begin reverse playback at normal (1x) speed: Press J.
m To pause playback: Press K.
m To double the current playback speed: Press L or J twice.
m To immediately reverse the playback direction: Press J to play in reverse, or press L to play forward.
m To move the playhead one frame at a time: Hold down the K key, and press J or L.
m To move the playhead at 1/2x speed: Hold down the K key while holding down J or L.
When you use keyboard shortcuts to control a device (like a camcorder or camera), the speed of 
forward (L) and reverse (J) playback may differ depending on your video equipment.
Play back media in a loop
You can turn on looping so that a project (or any portion of it) plays in a continuous loop.
1 To turn on looping, do one of the following:
• Choose View > Playback > Loop Playback (or press Command-L).
• Click the Loop Playback button.
2 Do one of the following:
• To loop your entire project: Press the Space bar.
• To loop a portion of your project: Select a range or a clip in the Timeline, and choose View > 
Playback > Selection, or press the Slash (/) key.Chapter 6 Play back and skim media 76
Play video in full-screen view
1 Select or open a project in the Project Library or open a clip in the Event Browser, and position 
the playhead where you want the video to begin.
2 Do one of the following:
• Choose View > Playback > Play Full Screen (or press Command-Shift-F).
• Click the Play Full Screen button below the Viewer.
The item plays in full-screen view starting at the playhead position.
3 To leave full-screen view, press the Esc (Escape) key.
When you play back clips, the frames under the playhead or skimmer play in the Viewer. If 
you need to compare two clips at once, you can use the Event Viewer, a separate viewer for 
playing back event clips only. The Event Viewer appears to the left of the main Viewer. For more 
information, see Play back and skim media in the Event Viewer on page 78.
Skim media
You can quickly skim your video and audio to preview it, search for a particular shot, or make an 
edit. When skimming is turned on and you move the pointer forward or backward over a clip in 
the Event Browser or the Timeline, the content under the pointer plays in the Viewer.
You can also use the Blade, Trim, and Range Selection editing tools to skim clips in the Timeline 
or in the Precision Editor.
As you’re editing in Final Cut Pro, you may find skimming distracting when you move the pointer 
from one location to another. You can disable all skimming (or just audio skimming).
Skim clips
m Move the pointer forward or backward over a clip in the Event Browser or the Timeline.
The skimmer (a vertical pink line) indicates exactly where the pointer is as you skim, and the 
corresponding frames are displayed in the Viewer.
Skimmer
Tip: You can also press the Space bar at any time to play forward from the skimmer position.Chapter 6 Play back and skim media 77
Skim clips with editing tools
You can skim clips when you use the Blade, Trim, and Range Selection tools in the Timeline or in 
the Precision Editor. The tools behave as skimmers as you move the pointer over a clip.
1 Select a clip in the Timeline or open the Precision Editor.
2 Select either the Blade, Trim, or Range Selection tool from the Tools pop-up menu in the toolbar.
3 Move the tool forward or backward over a clip.
When using an editing tool as a skimmer, you can skim and add markers to clips under 
connected clips in the Timeline.
Turn skimming on and off
m To turn all skimming on or off: Click the Skimming button, choose View > Skimming, or press S.
m To turn audio skimming on or off: Click the Audio Skimming button, choose View > Audio 
Skimming, or press Shift-S.
When skimming is turned on, the skimming buttons appear blue.
Audio skimming is turned off.
Skimming is turned on.
Note: When skimming is turned off, you can still skim with the Blade, Trim, and Range Selection 
editing tools. 
Skim audio for individual clips or audio components
You can turn on clip skimming to limit audio skimming to an individual clip. This is useful if you 
have a connected clip in the Timeline and want to skim it without also hearing audio from the 
clip in the primary storyline. 
Important: Audio skimming must also be turned on in order to use this feature.
You can also use clip skimming to skim and listen to an individual audio component when 
editing clips that show expanded audio components. If clip skimming is turned off, you hear 
combined audio for all components in the clip as you skim.
Tip: To view expanded audio components, select the clip in the Timeline and choose 
Clip > Expand Audio Components (or press Option-Control-S).
m To turn clip skimming on or off, choose View > Clip Skimming (or press Command-Option-S).Chapter 6 Play back and skim media 78
Play back and skim media in the EventViewer
Sometimes, you may need two viewers so that you can play back and skim event clips separately 
from Timeline clips. The Event Viewer is a separate video display that appears next to the main 
Viewer. With the Event Viewer and the Viewer open, you can display two clips at the same time: 
one in the Event Browser and one in the Timeline.
Event Viewer Viewer
You use the Event Viewer to play clips in the Event Browser only. As with the main Viewer, you 
can show video scopes, color channels, title and action safe zones, and multicam angles (with the 
Event Viewer set to show angles). Playback and adjustment controls are identical in the Viewer 
and the Event Viewer. Other viewer-related operations (including onscreen controls and built-in 
effects) are done with the main Viewer.
The dual-viewer interface is derived from linear tape-based systems, which included both source
and record monitors. The source monitor was for previewing source clips and making selections 
in them. The record monitor was for playing back the edited program.
Open the Event Viewer
m Choose Window > Show Event Viewer (or press Command-Control-3).
To close the Event Viewer, choose Window > Hide Event Viewer (or press Command-Control-3).
Note: If you’re using video scopes with the Event Viewer, you may find it convenient to display 
the scopes below the video image rather than on the left side (the default). To display scopes 
below the video image, choose Vertical Layout from the Settings pop-up menu in the Event 
Viewer. For more information, see Use the video scopes on page 370.
View playback on a second display
If you have a second display connected to your computer, you can show the Viewer on the 
second display to play video, or the Event Browser on the second display to view clips in an 
event, thereby expanding your workspace in the Final Cut Pro main window.
Show the Viewer on a second display
1 Connect a second display (a second computer monitor connected to the PCI video card), and 
make sure it is connected to power and turned on.
2 In Final Cut Pro, choose Window > Show Viewers on Second Display.
The Viewer appears on the second display. All Viewer features (including onscreen controls) are 
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Note: If the Event Viewer is also visible, both viewers appear on the second display.
3 To return the Viewer to the Final Cut Pro main window, choose Window > Show Viewers in the 
Main Window.
Show the Event Library and the Event Browser on a second display
1 Connect a second display (a second computer monitor connected to the PCI video card), and 
make sure it is connected to power and turned on.
2 In Final Cut Pro, choose Window > Show Events on Second Display.
The Event Library and Event Browser appear on the second display. All event features (including 
selection capabilities, markers, keywords, and so on) are now available on the second display.
To return the Event Library and Event Browser to the Final Cut Pro main window, choose 
Window > Show Events in the Main Window.
View playback on an external video monitor
Final Cut Pro includes an A/V Output option to send video and audio from your computer to 
an external video monitor. In addition to showing you how video and audio look and sound 
on an NTSC/PAL or HD broadcast monitor, this feature also allows you to test output with more 
sophisticated devices such as vectorscopes and waveform monitors.
A/V output is available only with OS X Lion v10.7.2 or later and requires compatible thirdparty video interface hardware and software. FireWire DV devices are not supported. For more 
information, contact the device manufacturer or go to the Final Cut Pro X Resources webpage at 
http://www.apple.com/finalcutpro/resources.
Play video and audio on an external video monitor
1 Install the video interface hardware and software according to the manufacturer’s instructions.
2 Connect an external video monitor to the video interface and make sure it’s connected to power 
and turned on.
3 To select an A/V output device, choose Final Cut Pro > Preferences (or press Command-Comma), 
click Playback, and choose a device in the Playback preferences pane.Chapter 6 Play back and skim media 80
4 In Final Cut Pro, choose Window > A/V Output.
The Viewer contents appear on the broadcast monitor. Viewer features (such as onscreen 
controls and the title-safe and action-safe overlays) can be viewed only in Final Cut Pro.
Note: Video and audio are synced at the video frame (not audio sample) level.
To turn off A/V output, choose Window > A/V Output.
About background rendering
When you add effects, transitions, generators, titles, and other items that require rendering 
before playback, the background render indicator (an orange bar) appears below the timecode 
in the Timeline. 
Background 
render indicator
By default, background rendering begins 5 seconds after you stop working and moving 
the pointer in Final Cut Pro. Background rendering continues while you work in a different 
application. You can change this setting in the Final Cut Pro preferences.81
Create a new project
To create a movie in Final Cut Pro, you first create a project, which provides a record of your 
editing decisions and the media you use. Then you add clips to the project Timeline and 
edit them.
When you create a new Final Cut Pro project, you do the following:
• Name the project.
• Specify a default event for the project.
The default event stores media that’s dragged to the project from the Finder or a Final Cut Pro 
media browser. If you drag media from the Finder to the project’s Timeline, that media is 
automatically located in the project’s default event.
Optionally, you can also set the starting timecode and define the video, audio, and render 
properties for the project.
After creating your project, you add clips to it from the Event Library.
Note: If you’re creating a project and you haven’t yet imported media into Final Cut Pro, you 
should do so. See Importing overview on page 19 for information.
Start a project
1 Do one of the following:
• In Final Cut Pro, choose File > New Project (or press Command-N).
• Make sure the Project Library is open, and click the New Project button. 
2 In the window that appears, type a name for the project in the Name field.
3 Choose a default event for the project.
If you drag any media files from the Finder directly to the project’s Timeline, or add media to 
the project from one of the media browsers, that media is automatically added to the project’s 
default event.
4 If you want to further customize settings for your project, click Use Custom Settings.
Note: Final Cut Pro shows the Automatic Settings by default, but it will remember the settings 
you used last, so this step may be unnecessary.
5 If you want your project’s timecode to start at a value other than 00:00:00:00, type a starting 
timecode value in the Starting Timecode field.
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6 If you want to make any changes to the project’s video or audio properties, select Custom and 
use the pop-up menus.
Unless you have a specific requirement for the project you’re creating, it’s best to leave “Set 
automatically based on first video clip” selected.
7 Click OK.
The new project appears in the Project Library with the name you gave it in step 2.
New project
You can now add clips from the Event Browser and begin to edit your project in other ways, 
adding titles, special effects, background music, sound effects, and more.
You can change a project’s name, default event, and project properties at any time. See Modify a 
project’s name and properties on page 83 for more information.
Preview and open a project
If you want to see the contents of a project, you can preview the project before opening it.
Preview a project
1 If the Project Library is not already open, click the Project Library button at the bottom-left 
corner of the Final Cut Pro main window.
2 Select a project in the Project Library.
3 To preview a project in the Viewer, select it and do one of the following:
• To skim the project: Move the pointer over the filmstrip (to the right of the project’s name).
• To play the project from the skimmer (the pink vertical line): Press the Space bar; press it again to 
stop playing the project.
Open a project
1 Open the Project Library.
2 Locate the project you want to open and double-click it.Chapter 7 Create and manage projects 83
Modify a project’s name and properties
As your project evolves, you may decide you want to rename it or change its properties.
Rename a project
1 If the Project Library is not already open, click the Project Library button at the bottom-left 
corner of the Final Cut Pro main window.
2 Select a project, and click the project’s name to highlight it.
3 Type a new name in the project Name field, and press Return.
Depending on how you have the Project Library organized, the project’s position in the project 
list may change after you rename it.
Change a project’s default event and properties
When you create a project, you set the project properties and assign the project a default event 
to hold media that is dragged directly into the project’s Timeline from a Final Cut Pro media 
browser or the Finder.
In most cases, Final Cut Pro manages project properties automatically based on the properties of 
the first clip you add to a project, but you can change almost all properties of an existing project. 
If you must modify the project properties, choose video and audio project properties based on 
how you intend to share your final movie with your audience.
1 Open the Project Library and select a project.
2 Do one of the following:
• Choose File > Project Properties (or press Command-J).
• If the Inspector pane is hidden, click the Inspector button in the toolbar.
Then click the Properties button at the top of the pane.
Properties button
3 Click the Project Properties button .
Project Properties 
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4 In the window that appears, change the settings as appropriate.
Choose a default Event 
from the pop-up menu.
Change the project’s 
video, audio, and 
render properties.
Name
• Name: Type a name for the project.
Default Event
• Default Event: Choose the default event for the project.
Starting Timecode
• Starting Timecode: If you want your project’s timecode to start at a value other than 
00:00:00:00, type a starting timecode value.
Drop Frame Timecode
• Drop Frame:Select the checkbox to turn on drop frame timecode (this option appears only for 
29.97 and 59.94 fps media). 
In non-drop frame timecode, the timecode counter counts at a consistent rate without 
dropping any numbers from the count. Non-drop frame timecode is available as a display 
option for every frame rate.
In drop frame timecode, frames 0 and 1 are skipped the first second of every minute, unless 
the minute number is exactly divisible by 10.
Video Properties
• Format:Choose the video format (a specific method of encoding the video).
• Resolution:Choose the frame size of the video.
• Rate:Choose the frames per second (fps).
Note: Unless the Timeline is completely empty, you cannot change the frame rate of an 
existing project.
Audio and Render Properties
• Audio Channels:Choose whether to present the audio as multichannel surround sound or 
as stereo.
• Audio Sample Rate:Choose the audio sample rate for your project (the number of times a 
signal is measured—or sampled—per second). A higher sample rate produces higher-quality 
audio and larger file sizes, and a lower sample rate produces lower-quality audio and smaller 
file sizes. Which sample rate you choose to work with depends on the source material you’re 
working with, and the final destination of your audio.
• Render Format:Choose the codec to use for your project’s background rendering.
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Define the order in which events are referenced by a project
If you have duplicate clips in different events, you can define the order in which Final Cut Pro 
looks for the clips.
1 Open the Project Library and select a project.
2 Do one of the following:
• Choose File > Project Properties (or press Command-J).
• If the Inspector pane is hidden, click the Inspector button in the toolbar.
Then click the Properties button at the top of the pane.
Properties button
3 Click the Modify Event References button in the Referenced Events section.
4 In the window that appears, drag the events to set the order in which Final Cut Pro will look 
for clips.
5 When you’ve set the order, click OK.Chapter 7 Create and manage projects 86
Organize projectsin the Project Library
All your Final Cut Pro video projects are listed in the Project Library. You can start organizing your 
projects by connecting additional hard disks, creating folders to hold projects, and giving your 
projects clear and specific names. As your Project Library grows, you can rename, copy, move, 
and delete your projects as necessary.
Use folders to sort projects
1 If the Project Library is not already open, click the Project Library button at the bottom-left 
corner of the Final Cut Pro main window.
2 Select a disk, folder, or project to which you want to add a folder, and click the New Folder 
button at the bottom-left corner of the Final Cut Pro main window.
A new folder called New Folder appears inside the disk or folder you selected, or at the same 
level as the project you selected.
3 Do any of the following: 
• To rename the folder: Select the folder, click the folder name, and type a new name.
• To add a project to the folder: Drag the project to the folder.
• To open or close the folder: Click the disclosure triangle to the left of the folder name.
Copy a project
Copying a project is useful if you want to work on a new version of a project or transfer a copy 
to another computer.
1 Open the Project Library and select a project.
2 Choose File > Duplicate Project.
3 In the window that appears, choose a location for the duplicated file from the Location 
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4 Select an option to specify what is duplicated:
• Duplicate Project Only: Duplicates only the project file.
• Duplicate Project and Referenced Events: Duplicates the project file, any events referred to by the 
project file, and all of the media in the referenced events.
• Duplicate Project + Used Clips Only: Duplicates the project file and the media files for any clips 
used in the project.
• Include Render Files: Select this checkbox to include render files for the clips and projects. If you 
want to free up hard disk space, deselect this checkbox.
Choose a location to put 
the copied project.
Select a duplicate option.
5 Click OK.
Final Cut Pro copies the project to the location you chose using the option you specified. The 
project is given an appended name (for example, “Bill’s movie1”), and the project appears in the 
Project Library.
Quickly copy a project to a connected external storage device
m Open the Project Library, select a project, and drag the project to another hard disk’s icon in the 
Project Library.
Move a project
You can easily move a project to a connected hard disk or another computer. Moving a project 
file is useful if you want to work on a project using another computer that has Final Cut Pro 
installed, or if you want to free up space on your computer’s hard disk.
Important: You cannot undo a project move with the Undo command.
1 Open the Project Library and select a project.
2 Do one of the following:
• Choose File > Move Project.
• Hold down the Command key while you drag the project to another hard disk’s icon in the 
Project Library.
3 In the window that appears, choose where you want to move the project (to a hard disk or 
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4 Select an option to specify what is moved:
• Move Project Only: Moves only the project file.
• Move Project and Referenced Events: Moves the project file, any events referred to by the project 
file, and all of the media in the referenced events. 
Choose a location 
to which you want 
to move the project.
Select a move option.
5 Click OK.
Final Cut Pro moves the project to the location you chose using the option you specified. See 
Where your media and project files are located on page 390 for information about the default 
location of Final Cut Pro projects and events.
Delete a project or project folder
Deleting a project folder deletes the folder and all of the projects it contains. Your media is not 
deleted because media is stored in events.
1 Open the Project Library and select a project.
2 Do one of the following:
• To delete a project: Select the project and choose File > Move Project to Trash (or press 
Command-Delete).
• To delete a folder and any projects the folder contains: Select the folder and choose File > Move 
Folder to Trash (or press Command-Delete).
The project or project folder (and the projects the folder contains) is removed from the Project 
Library and moved into the Finder Trash.
3 To permanently delete the project or project folder and its files and free up space on your hard 
disk, empty the Finder Trash.
WARNING: After the Trash is emptied, the file or folder cannot be restored.
You can also delete a project’s render files. See View background tasks on page 400 for 
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Save projects
Final Cut Pro automatically saves all the changes you make as you work on a project, which 
means you never have to save changes manually. Also, you can undo all of your changes up 
to the last time you quit and reopened Final Cut Pro by choosing Edit > Undo (or pressing 
Command-Z).
You can create multiple versions of a project by duplicating it. For more information about 
duplicating projects, see Organize projects in the Project Library on page 86.
Changes you make to a clip in a project do not affect the clip’s source file. Thus, if you’ve made a 
lot of changes to a clip but want to start fresh, you can easily restore the clip to its original state 
by adding a new copy of the clip (located in the Event Library) to your project.90
Editing overview
The term video editing refers both to broader stages of a project workflow and to very specific 
manual tasks that you do with clips in a project Timeline.
• Make selections and add clips to the Timeline: Adding and arranging clips in your project is the 
fundamental step in creating a movie with Final Cut Pro. You move and reorder clips in the 
Timeline. See Adding clips overview on page 99, Arrange clips in the Timeline on page 117, 
and Audio overview on page 157. 
• Cut and trim clips: Final Cut Pro provides a wide variety of tools for adjusting the start and 
end points of clips in the Timeline and for controlling pacing from one shot to the next. See 
Trimming overview on page 123. 
• Further refine and adjust your project: Final Cut Pro provides many advanced editing tools to 
finish a highly polished movie with ease. See topics in the advanced editing section.
• Add effects and color correction: Finishing touches include visual effects and color correction. 
See Transitions, titles, effects, and generators overview on page 204 and Color correction 
overview on page 355.
Select clips and ranges
About selections and filmstrips
A fundamental step in editing a video project is choosing what you want to include in your 
final movie. In Final Cut Pro you indicate what clips or portions of clips you want to act on by 
making a selection. Final Cut Pro provides a variety of powerful tools for making selections with 
both speed and precision, including filmstrips, which are connected series of thumbnail images. 
Your video clips appear as filmstrips in the Timeline (where you build projects) and in the Event 
Browser (where your source media is displayed). A single video filmstrip might represent several 
seconds of video encompassing hundreds of video frames (individual images). Audio-only clips 
appear as audio waveforms, showing the change in the audio volume over time.
When you add clips from the Event Browser to a project in the Timeline, you can add one 
or more whole clips, or you can add a range within a clip. Then you can fine-tune the clips 
individually in the Timeline, adding video effects to them, for example, or inserting transitions 
between them. 
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You can adjust the appearance of filmstrips in the Event Browser and the Timeline so that it’s 
easier to make selections. For example, expanding the width of a filmstrip (by showing shorter 
durations per thumbnail) helps you make more precise selections.
Filmstrip expanded 
in the Event Browser 
for precise selections
You can also adjust the filmstrip appearance in the Timeline to make it easier to view and select 
audio waveforms.
Filmstrip appearance 
changed for easy 
viewing and selection 
of audio waveforms
Select one or more clips
Clips represent your video, audio, and graphics files and allow you to work with your media in 
Final Cut Pro without changing the files themselves. To add clips to your project, rearrange them, 
or trim them, you first need to select them. You can select a single clip or multiple clips at a time.
Selecting multiple clips allows you to move them as a group within your project, or from one 
event to another. It’s also useful if you’ve made adjustments to a clip and you want to paste the 
same adjustments onto several other clips.Chapter 8 Edit your project 92
Select an entire clip
Do one of the following:
m Click the clip once.
m Move the skimmer (or the playhead) over a clip and press X.
Note: This results in a range selection that matches the boundaries of the clip.
m In the Event Browser, press Up Arrow or Down Arrow to move the selection to a neighboring clip.
m In the Event Browser, Option-drag from the start point to the end point of the clip.
m In the Timeline, move the skimmer (or the playhead if skimming is turned off) over the clip you 
want to select and press C. This method selects the clip in the primary storyline.
Connected clips and storylines are attached to clips in the primary storyline, and they appear 
above and below the primary storyline. To select a connected clip or storyline with this keyboard 
shortcut method, position the pointer on the connected clip and press C. For more information, 
see Connect clips to add cutaway shots, titles, and synchronized sound effects on page 103 and 
Add storylines on page 265.
A yellow border appears around the clip, indicating that it is selected.
Note: A Timeline clip selection (shown above) is different from a Timeline range selection, which 
has visibly distinct range handles for adjusting the selection start point and end point. 
All selections in the Event Browser are actually range selections (with adjustable start and 
end points).
Select multiple clips in the Event Browser or the Timeline
m To select a number of individual clips: Hold down the Command key as you click the clips you want 
to select.
Note: Command-clicking an Event Browser clip with preexisting ranges selects the ranges rather 
than the whole clip.
m To select all clips and ranges in the Event Browser or the Timeline: Click the Event Browser or 
Timeline to make it active, and choose Edit > Select All (or press Command-A).Chapter 8 Edit your project 93
m To select multiple clips by dragging: Drag a selection rectangle over the Timeline or event clips you 
want to select.
Deselect clips in the Event Browser or the Timeline
m To deselect a single selected clip: Command-click the clip or click outside it (or select a 
different clip).
m To deselect multiple selected clips: Hold down the Command key and click the clips you don’t 
want selected.
m To deselect all clips and ranges: Choose Edit > Select > None (or press Command-Shift-A).
m To deselect all clips and clear all selected ranges in the Event Browser: Press Option-X.
Select a range
Instead of selecting whole clips, you can select a range within any clip in the Timeline or in the 
Event Browser. In the Timeline, you can also select a range that spans multiple clips. You can trim 
range selections, mark them with ratings and keywords, and modify them in other ways. You can 
adjust the range selection start and end points by dragging either side of the selection. You can 
also create multiple range selections in one or more clips in the Event Browser.
Range handles
Note: This illustration shows a Timeline range selection. Event Browser range selections have 
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Select a range
Do one of the following:
m In the Event Browser, drag across any clip (filmstrip). 
A yellow border appears around the range you selected.
If the filmstrip wraps onto two lines, you can select a range extending over the break simply 
by continuing to drag across the break. When you reach the edge, the pointer jumps to the 
next line.
Tip: In the Event Browser, Option-drag across any clip (filmstrip) with existing ranges to replace 
those ranges with a new range.
m In the Timeline, choose Range Selection from the Tools pop-up menu in the toolbar (or press R).
The pointer changes to the Range Selection tool . 
Drag the Range Selection tool across one or more clips in the Timeline to select a range. 
To adjust the range selection start and end points, drag the range handles on either side of 
the range.
Tip: To temporarily turn on the Range Selection tool, hold down the R key. When you release the 
R key, the tool reverts to the previously active tool.
Range handles
m Use the I and O keys to set the range selection start and end points. For more information, see 
the instructions below. 
m In the Event Browser or the Timeline, move the skimmer (or the playhead) over a clip and press X. 
Final Cut Pro sets the range selection start and end points at the clip start and end points.
Tip: To use this X key method with connected clips or clips in a connected storyline, position the 
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m Command-click a colored marker line at the top of a clip.
These marker lines can indicate any of the following: Favorite (green), Rejected (red), manually 
applied keywords (blue), or analysis keywords (purple).
Set a range start point or end point
m To set the start point: Position the skimmer (or the playhead, if skimming is turned off) where you 
want the selection to start, and choose Mark > Set Range Start (or press I). 
 To remove the range start point, press Option-I.
m To set the end point: Position the skimmer (or the playhead, if skimming is turned off) where you 
want the range to end, and choose Mark > Set Range End (or press O). 
To remove the range end point, press Option-O.
m To set the range start point or end point while a clip or your project is playing back: Press the Space 
bar to start playback, and then press the I or O key when you want to set the start or end point. 
Tip: In the Event Browser, you can press Command-Shift-I and Command-Shift-O to set multiple 
ranges during playback.
If you’re using the Blade, Trim, and Range Selection tools in the Timeline or in the Precision Editor, 
you can use the I and O keys to set selection start and end points in a connected clip or storyline, 
as well as in clips underneath connected clips and storylines. Move the pointer directly over a clip 
and press I to set a selection start point or O to set a selection end point.
Extend or shorten the range selection
m To adjust where the range starts or ends: Drag the left or right edge of the yellow selection border.
m To reset the start point or end point for a range within the same event clip or project: Move the 
skimmer and press I or O.
Tip: You can also press the I or O key while a clip is playing back.
m To extend or shorten a range within an event clip: Move the skimmer to any frame that you want 
the range to begin or end with, and then hold down the Shift key and click (or drag). 
m To extend or shorten a range using timecode: Choose Modify > Change Duration (or press 
Control-D), and enter a new duration. (This method works with single range selections only.)
The range selection is lengthened or shortened accordingly.
If you require the skimmer and it is not present, you can turn on skimming at any time.
Set multiple ranges in event clips during playback
You can set multiple ranges in clips in the Event Browser during playback.
1 Play back an event clip.
2 While the clip is playing, do either of the following:
• To add a range start point: Press Command-Shift-I.
• To add a range end point: Press Command-Shift-O.
Note: To set multiple ranges in the same clip, repeat these keyboard shortcuts while 
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Set the range selection to match the boundaries of the clip
m Move the skimmer (or the playhead) over a clip and press X.
Final Cut Pro sets a range selection from the start point to the end point of the clip. Any 
preexisting ranges are removed.
Clear ranges
You can remove one or more ranges from the Event Browser or the Timeline.
Note: This operation does not affect the clip media in either the Event Browser or the Timeline.
m To remove an individual range in an event: Option-click the range.
m To remove a range in the Timeline: Click outside of the range or select a different range.
m To clear one or more ranges in the Event Browser or the Timeline: Select the range or ranges and 
choose Mark > Clear Selected Ranges (or press Option-X).
Note: Selected ranges have a thick yellow border. Unselected ranges (available only in the Event 
Browser) have a thin orange border.
m To remove all ranges in an event: Choose Edit > Select All (or press Command-A) to select all 
ranges in the current event, and choose Mark > Clear Selected Ranges (or press Option-X).
Manage multiple range selections in event clips
In the Event Browser, you can set multiple ranges within one or more clips, and you can select 
and deselect ranges after you set them. For example, you might set multiple ranges in a long 
event clip, and then deselect some of the ranges before adding all of the selected ranges to the 
Timeline at once.
Note: Selected ranges have a thick yellow border. Unselected ranges have a thin orange border. 
Editing commands operate on yellow selections only.
Selected ranges Unselected ranges
Note: The commands described in this section require the Event Browser to be the active 
portion of the Final Cut Pro interface. You can make the Event Browser active by moving the 
pointer over it or clicking it. When the Event Browser is active, its background has a lighter 
gray color.Chapter 8 Edit your project 97
Set multiple ranges in an event clip
1 In the Event Browser, select a range within a clip.
2 To set an additional range, do one of the following:
• Command-drag in a different section of the clip.
• Move the skimmer (or the playhead) to the frame where you want the additional range to 
start and press Command-Shift-I. Move the skimmer or playhead to the frame where you want 
the additional range to end and press Command-Shift-O.
Note: These keyboard shortcuts also work during playback, so you can set additional ranges 
on the fly. 
• Option-drag over or within existing ranges to replace them with a new range.
• Command-click a colored marker line at the top of a clip.
These marker lines can indicate any of the following: Favorite (green), Rejected (red), manually 
applied keywords (blue), or analysis keywords (purple).
The additional range selection appears in the clip.
To remove a range selection, Option-click it.Chapter 8 Edit your project 98
Select and deselect ranges and clips in an event
You can set, select, or deselect multiple ranges within event clips or within events.
Important: Editing commands operate on yellow selections only. Editing commands ignore 
orange (unselected) ranges.
Selected ranges Unselected ranges
m To select an individual range: Click the range.
m To select or deselect a range: Command-click the range.
m To select all ranges in a clip: Click an area of the clip that has no range.
m To select all ranges and clips in the current event: Choose Edit > Select All (or press Command-A).
The ranges (and all clips with no ranges) are selected with a yellow border. 
m To deselect all ranges and clips in the current event: Choose Edit > Deselect All (or press 
Command-Shift-A). 
The ranges turn orange.
Remove ranges from clips in an event
You can remove individual ranges, multiple ranges, or all ranges from the current event.
m To remove an individual range in an event: Option-click the range.
m To remove selected ranges in an event: Select the ranges you want to remove, and choose Mark > 
Clear Selected Ranges (or press Option-X).
m To remove all ranges in an event: Choose Edit > Select All (or press Command-A) to select all 
ranges in the current event, and choose Mark > Clear Selected Ranges (or press Option-X).
Navigate between selections in an event
m To go to the start of the range selection: Choose Mark > Go to > Range Start (or press Shift-I).
Repeat this command to go to the start of the previous range selection, or to the start of the clip. 
m To go to the end of the range selection: Choose Mark > Go to > Range End (or press Shift-O).
Repeat this command to go to the end of the next range selection, or to the end of the clip.
m To select the previous clip (or its ranges): Press Up Arrow.
To add to the selection, press Shift–Up Arrow. 
m To select the next clip (or its ranges): Press Down Arrow.
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Add and remove clips
Adding clips overview
You build a movie project by adding clips to the Timeline in a chronological arrangement. To suit 
your particular editing style or need, you can choose from a wide variety of tools and techniques 
for adding clips. You can change the arrangement of the clips in the Timeline at any time.
In Final Cut Pro, you can edit your projects without worrying about maintaining clip connection 
or synchronization. For example, when you drag a clip into the Timeline, Final Cut Pro 
automatically rearranges the Timeline to fit each new clip without disturbing your existing work. 
This is true for all kinds of clips: video, audio, titles, generators, still images, and so on.
You can use clips from multiple events in a single project. You can also add clips from the 
Final Cut Pro media browsers and from the Finder. Deleting clips from the Timeline does not 
affect clips or files in the Event Browser, the media browsers, or the Finder.
Connected clips and storylines remain attached to, and synchronized with, clips in the primary 
storyline until you explicitly move or remove them.
Connected clip
Connected 
audio-only clip
Primary storyline
Drag clips to the Timeline
You can add clips to the Timeline by dragging them from the Event Browser, from a Final Cut Pro 
media browser (such as the Photos Browser or the Generators Browser), or from the Finder.
Drag clips from the Event Browser or a media browser
1 Do one of the following:
• In the Event Library, select an event containing the clips you want to add to your project.
• Open the media browser containing the media you want to add to your project.
2 Drag one or more clips to the Timeline from the Event Browser or a media browser.
Depending on where you drag the clips in the Timeline, your actions may result in an append, an 
insert, a connect, or a replace edit. Final Cut Pro automatically adjusts surrounding clips to fit in 
place around any clips you’ve dragged.
Tip: You can add one clip to your project at a time, or sometimes it’s easier to add a number of 
clips to the project at once, and then rearrange them in the Timeline.Chapter 8 Edit your project 100
Drag files from the Finder
1 Arrange the windows onscreen so that you can see both the Final Cut Pro main window and the 
files in the Finder.
2 Drag the files from the Finder to the Timeline.
Depending on where you drag the clips in the Timeline, your actions may result in an append, an 
insert, a connect, or a replace edit. 
Note: If you add clips to the Timeline from a Final Cut Pro media browser or the Finder, you are 
effectively importing the media into the default event associated with the current project. You 
can configure the default event in the project settings window. In this scenario, Final Cut Pro 
applies the default optimization and analysis settings to the new clips. You can set default 
optimization and analysis processes in Final Cut Pro preferences.
If you add still images to the Timeline, they will have a duration of 4 seconds by default. You can 
change this default duration in Final Cut Pro preferences. 
Append clips to your project 
A simple way to add a clip to your project is an append edit, in which you add one or more clips 
to the end of a project or storyline.
Append clips to your project in the Timeline 
1 Select one or more clips in the Event Browser.
2 To add the clips to the Timeline, do one of the following: 
• Choose Edit > Append to End (or press E).
• Click the Append button in the toolbar.
If there is no selection, the clip appears at the end of the primary storyline in the Timeline. If a 
storyline is selected, the clip appears at the end of the selected storyline.
Insert clips in your project
An insert edit places the source clip so that all clips after the insertion point are moved forward 
(or rippled) in the Timeline to make room for the clip being added. No clips are removed from 
your project. An insert edit makes the project longer by the duration of the inserted clip. 
D A B C
A D B C
After edit
Before edit
You might use insert edits when you want to add a new shot in the beginning or the middle of 
your project. You can also use an insert edit to interrupt the action in an existing clip with the 
action in the newly inserted clip. The action in the original clip then resumes after the inserted clip.
Note: You can use three-point editing to make insert edits. For more information, see Three-point 
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Insert Event Browser clips in the Timeline
1 Select one or more clips in the Event Browser.
2 Move the playhead to the point in the primary storyline or a selected storyline (or make a range 
selection) where you want to insert the clip.
3 Do one of the following:
• Choose Edit > Insert (or press W).
Note: If you use the keyboard shortcut and the skimmer is present in the Timeline, the edit 
will occur at the skimmer position.
• Click the Insert button in the toolbar.
The clip appears in the Timeline and all clips after the insertion point are rippled forward. If the 
skimmer is not present, the clips are inserted at the playhead position. If you perform an insert 
edit in the middle of an existing Timeline clip, that clip is cut at the insertion point, and the 
second half is moved to the end of the newly inserted clip, along with the rest of the footage to 
the right of the insertion point. 
Insert a gap clip or a placeholder clip in the Timeline
Sometimes you need to reserve space in the Timeline for a clip that you don’t yet have. 
Final Cut Pro provides two possible solutions to this problem: placeholder imagery or a blank 
and silent clip called a gap clip that can be adjusted to any duration.
1 Move the playhead to the point in the primary storyline or a selected storyline (or make a range 
selection) where you want to insert the gap clip or placeholder clip.
2 Do either of the following:
• To insert a placeholder clip: Choose Edit > Insert Placeholder (or press Command-Option-W). 
Final Cut Pro inserts gray placeholder imagery that you can customize. For more information, 
see Use a placeholder on page 238. You can adjust placeholder clips to any duration.
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• To insert a gap clip: Choose Edit > Insert Gap (or press Option-W).
Final Cut Pro inserts a blank clip (containing blank video and silent audio) that you can adjust 
to any duration. (The film industry term for this is slug.)
Gap clip
Note: Gap clip color is determined by the current background color in Final Cut Pro. To 
adjust the background color, choose a Player Background option in the Playback pane 
of the Final Cut Pro Preferences window. If you want a different color, consider using a 
solid generator.
The clip appears in the Timeline, and all clips after the insertion point are rippled forward (to 
the right).
Insert clips by dragging them from the Event Browser, a media browser, or the Finder
You can insert clips between clips in the Timeline by dragging them from the Event Browser, 
another Final Cut Pro media browser, or the Finder.
m Drag the clip you want to insert to an edit point (between two clips) in the Timeline.
The clip appears in the Timeline, and all clips after the insertion point are rippled forward (to 
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Connect clips to add cutaway shots, titles, and synchronized sound effects
You can attach clips to other clips in the Timeline. Connected clips remain attached and 
synchronized until you explicitly move or remove them. 
A B C
D
A B C
D
After edit
Before edit
Some uses for connected clips include:
• Cutaway shots: Add a cutaway shot by connecting it to a video clip in the Timeline.
• Superimpose titles: Add a title or a lower third to a video clip or range. 
• Spot sound effects and background music: Synchronize audio clips to clips in the primary 
storyline. The clips will remain synchronized even if you move the primary storyline clips.
When you use the Connect menu command, keyboard shortcut, or toolbar button, video clips 
(blue) are connected above the primary storyline and audio clips (green) are connected below 
the primary storyline:
Connected clip
Connected 
audio-only clip
Primary storyline
Note: You can use three-point editing to make connect edits. For more information, see Threepoint editing overview on page 275.Chapter 8 Edit your project 104
Connect clips in the Timeline 
1 If your project is empty, add clips to the dark gray primary storyline area in the Timeline to build 
your initial sequence.
 The clips in the primary storyline serve as a foundation on which you connect (attach) clips to 
further build your project. Connect edits are slightly different than the other edit types in that 
they never add clips to the primary storyline. If you perform a connect edit in an empty Timeline, 
Final Cut Pro first adds a gap clip to the primary storyline and attaches the new connected clip 
to it.
2 Select one or more clips or a range in the Event Browser.
3 Do one of the following to indicate where you want to connect the selected source clip:
• Position the playhead over the frame of the clip in the primary storyline.
• Make a range selection in the primary storyline.
4 To connect the selected clips to the clips in the primary storyline, do one of the following:
• Choose Edit > Connect to Primary Storyline (or press Q).
Note: If you use the keyboard shortcut and the skimmer is present in the Timeline, the clip 
will be connected at the skimmer position.
• Click the Connect button in the toolbar.
• Drag the clips to the gray area above or below the primary storyline.Chapter 8 Edit your project 105
The first frame of the source selection is connected to the clip in the primary storyline at the 
playhead or skimmer position. If you dragged the selection to the Timeline, the first frame of 
the source selection is connected to the primary storyline at the point where you released the 
mouse button.
Connection point
Connected clip
Primary storyline
When you rearrange, move, ripple, or remove clips in the primary storyline, any clips connected 
to them will move (or be deleted) along with the primary storyline clips. Chapter 8 Edit your project 106
When you connect clips by dragging them, you have the option to put video clips below the 
primary storyline or put audio clips above the primary storyline.
Connected 
audio-only clip
Connected 
audio/video clip
Title
Note: In Final Cut Pro, if you connect clips, the topmost video clips block out any video clips 
below them. Exceptions to this rule are clips with some type of transparency, keying, or 
compositing settings. For more information, see Compositing overview on page 351. Audio clips 
never affect video output, even when they are placed above video clips in the Timeline.
Adjust the connection point of a connected clip
By default, connected clips and storylines are connected to the primary storyline at their first 
frame, but you can move the “connection point” of a connected clip or storyline. This is useful 
when you want to connect a specific frame or audio sample in the connected clip or storyline 
with a specific frame or audio sample in the primary storyline.
m Hold down the Command and Option keys, and click the connected clip (or the gray border of 
the storyline) at the point where you want to position the connection point.
The connection point is moved to the point where you clicked.
Default 
connection point
New connection 
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Move, trim, or delete clips in the primary storyline without affecting connected clips
If you need to move or trim clips in the primary storyline but want to keep any connected clips 
where they are, you can hold down the Grave Accent (`) key while editing to preserve the timing 
and position of connected clips.
m To move a clip without affecting connected clips: While holding down the Grave Accent (`) key,drag 
the clip to another location in the Timeline (using either the Select tool or the Position tool).
Hold down the Grave Accent (`) 
key and drag the clip.
The connected clip 
remains in place.
m To trim a clip without affecting connected clips: While holding down the Grave Accent (`) key,trim 
the clip using any method, including ripple edits, roll edits, slip edits, and slide edits.
m To delete a clip without affecting connected clips: While holding down the Grave Accent (`) key, 
select the clip and press Delete (or press Command-Option-Delete).
For more information about removing clips or ranges that have connected clips, see Remove 
clips from your project on page 115.
m To switch to an alternate clip in an audition without affecting connected clips: While holding down 
the Grave Accent (`) key,select the pick in the Audition window.
For more information, see Use auditions to try out clips in your project on page 284.
In all of these cases, the connected clip (or clips) remains exactly in the same position, with its 
timing preserved.
If you remove clips or ranges involved with connected clips and storylines without holding down 
the Grave Accent (`) key, special rules apply. For more information, see Remove clips from your 
project on page 115.Chapter 8 Edit your project 108
Overwrite parts of your project
In an overwrite edit, one or more source clips overwrite any clips in the primary storyline or 
a selected storyline, starting at a range selection start point or at the playhead or skimmer 
position. No clip items are rippled forward, so the duration of your project remains the same.
A B C
A D B C
D
After edit
Before edit
Overwriting media is different from replacing it. Overwriting works with range selections only, 
not entire clips, and it is not constrained by clip boundaries. Use an overwrite edit when you 
want to edit media for a specific span of time, rather than specific shots.
Note: You can use three-point editing to make overwrite edits. For more information, see Threepoint editing overview on page 275.
Overwrite clips in the Timeline with clips from the Event Browser
1 Select one or more clips in the Event Browser.
If there are multiple source clips in the selection, the clips will appear in the Timeline in the order 
in which they were selected.
2 To define where you want the overwrite clip to start in the Timeline, do one of the following in 
the primary storyline or a selected storyline:
• Position the playhead.
• Select a range involving one or more clips in the Timeline.
Note: The overwrite command ignores whole clip selections in the Timeline. If you don’t select 
a range in the Timeline, Final Cut Pro positions the start of the overwrite clip at the playhead or 
skimmer position.
3 Choose Edit > Overwrite (or press D).
The source clip appears in the primary storyline and overwrites any clips for the duration of the 
source clip. 
Note: If you use the keyboard shortcut and the skimmer is present in the Timeline, the edit will 
occur at the skimmer position.
To overwrite from the playhead back, so that the overwrite clip’s end point (rather than its start
point) is aligned at the target position, press Shift-D.Chapter 8 Edit your project 109
Replace a clip in your project with another clip
You can replace clips in your project with clips from the Event Browser, other Final Cut Pro media 
browsers, or the Finder. In contrast to overwrite edits, replacing works on whole Timeline clips 
only and can change the duration of your project.
A B C
A D C
D
After edit
Before edit
 Replace options include using the start or end of the source clip, as well as automatically 
creating or adding to auditions.
Replace a clip in the Timeline with one or more clips by dragging
1 Do one of the following to make a source selection:
• Select a clip or range in the Event Browser.
• Select a media item in one of the Final Cut Pro media browsers or in the Finder.
2 Drag the source selection over the clip in the Timeline you want to replace.
The target clip in the Timeline is highlighted with a white outline.Chapter 8 Edit your project 110
3 Release the mouse button and choose an option from the shortcut menu:
• Replace: The target clip is replaced with the source clip selection. The duration is determined 
by the duration of the source clip selection. If the source clip selection and the target clip have 
different durations, the subsequent clips ripple.
• Replace from Start: The target clip is replaced with the source clip selection, starting from 
the beginning of the source selection. The duration is determined by the duration of the 
Timeline clip.
• Replace from End: The target clip is replaced with the source clip selection, starting from the 
end of the source selection. The duration is determined by the duration of the Timeline clip.
• Replace and add to Audition: The target clip is replaced with an audition that has the source 
clip selection as the pick and the target clip as an alternate. The duration is determined by 
the source clip selection. If the source clip and the target clip have different durations, the 
subsequent clips ripple.
• Add to Audition: The target clip is replaced with an audition that has the target clip as the pick 
and the source clip selection as an alternate.
• Cancel: The replace edit is canceled.
The source clip selection appears in the Timeline, in place of the original clip.
The source clip selection 
appears in the Timeline.
Note: In the case of Replace from Start and Replace from End, if the source clip selection is a 
range selection with a shorter duration than that of the target clip and there is sufficient extra 
media, Final Cut Pro extends the duration of the source selection to match the target clip 
duration. The resulting storyline duration does not change.Chapter 8 Edit your project 111
Replace a clip in the Timeline using keyboard shortcuts
1 In the Event Browser, select the source clip or range.
2 In the Timeline, select the clip you want to replace.
Note: This must be a whole clip selection, not a range selection. For more information, see About 
selections and filmstrips on page 90.
3 Do one of the following:
• To perform a standard replace edit: Press Shift-R.
The target clip is replaced with the source clip selection. The duration is determined by the 
duration of the source clip selection. If the source clip selection and the target clip have 
different durations, the subsequent clips ripple.
• To perform a Replace from Start edit: Press Option-R.
The target clip is replaced with the source clip, starting from the beginning of the source clip. 
The duration is determined by the duration of the Timeline clip.
Note: In the case of Replace from Start, if the source clip selection is a range selection with a 
shorter duration than that of the target clip and there is sufficient extra media, Final Cut Pro 
extends the source selection to match the target clip duration. The resulting storyline duration 
does not change.
The source clip selection appears in the Timeline, in place of the original clip.
Add and edit still images
In Final Cut Pro, you can add and edit a variety of still-image formats in your projects, including 
photos and graphics files.
Add a still image to the Timeline
You can add still images to your project from the Event Browser or the Photos Browser.
m To add a still image from the Event Browser: Import the still image into an event, and then select all 
or part of the still-image clip and drag it from the Event Browser to the Timeline.
Note: Once a still image is imported, it functions like any other clip in Final Cut Pro. You can use 
any of the techniques described in this chapter to add still-image clips to the Timeline.
m To add a still image from the Photos Browser: Open the Photos Browser, select a still image, and 
drag it directly into the Timeline.
The default initial duration for range selections in still images is 4 seconds, but you can change 
this setting in the Editing pane of Final Cut Pro preferences.
There is no limit on the duration of a still-image clip. To adjust the duration of a still-image clip in 
the Timeline, use any of the trimming techniques described in this chapter. To adjust the duration 
of multiple still-image clips at once, select the clips and choose Modify > Change Duration (or 
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Add layered graphics files to the Timeline
You can add layered graphics files, such as Adobe Photoshop (PSD) files, created with another 
image editing application to the Timeline.
1 Import the layered graphics file into an event.
Important: If the layered graphics file has a transparent background, make sure your project’s 
render format is set to Apple ProRes 4444 to preserve the transparency when rendering. See 
Modify a project’s name and properties on page 83.
2 In the Event Browser, Control-click the layered graphics image and choose Open in Timeline from 
the shortcut menu.
Each layer appears in the Timeline as a connected clip that you can edit as you would any other 
clip. For example, you can animate layers by fading them in or out.
Layered graphics image in the Viewer
Clips representing individual layers
The default duration for a layered graphics file is one minute. To adjust the duration of one of the 
layers in the Timeline, use any of the trimming techniques described in this chapter. To adjust the 
duration of all the layers, select them and choose Modify > Change Duration (or press Control-D).
For more information on creating layered graphics files for Final Cut Pro, go to 
http://support.apple.com/kb/HT5152.
Edit a still image with an external image editing application
You can modify a still image with an external image editing application, and the changes appear 
automatically in the clip in Final Cut Pro. 
1 To add a still-image clip to the Timeline, follow the steps above.
2 To locate the clip’s source media file in the Finder, press Command-Shift-R. 
3 Open the source media file in the external image editing application.
4 In the image editing application, modify the image and save the changes.
5 Switch back to Final Cut Pro.
The changes appear automatically in the still-image clip in Final Cut Pro.Chapter 8 Edit your project 113
You can also create freeze frames from your video clips. For more information, see Create freeze 
frames on page 113.
Create freeze frames
You can easily create freeze-frame clips from any video clip. Freeze-frame clips hold a particular 
frame in place, temporarily stopping the action onscreen.
You can create freeze-frame clips from clips in the Timeline or the Event Browser. If you create a 
freeze-frame clip from the Event Browser, it is attached to the primary storyline at the playhead 
location as a connected clip.
You can create freeze frames on the fly during playback or by navigating to a specific frame in 
a clip.
Note: A freeze-frame clip preserves any attributes that were applied to the source clip, such as 
settings and effects.
Create a freeze-frame clip
1 In the Timeline or the Event Browser, do one of the following:
• Move the skimmer or playhead to the frame you want to freeze.
• Begin playback of the clip.
2 Choose Edit > Add Freeze Frame (or press Option-F).
How the freeze frame is added to the project depends on whether the freeze frame was created 
from the Timeline or the Event Browser.
• If you created the freeze frame from a clip in the Timeline: A new freeze-frame clip is inserted at 
the skimmer or playhead location in the Timeline.
• If you created the freeze frame from a clip in the Event Browser: A new freeze-frame clip is 
attached as a connected clip at the playhead location in the Timeline.Chapter 8 Edit your project 114
Change the default duration of freeze-frame clips
Freeze-frame clips have the same default duration as still-image clips: 4 seconds. You can change 
the default duration in Final Cut Pro preferences.
1 Choose Final Cut Pro > Preferences (or press Command-Comma), and click the Editing button at 
the top of the window.
2 Adjust the Still Images value slider.
If you don’t want to create a separate clip for freeze frames, you can create a hold segment using 
the Retime pop-up menu. For more information, see Create a hold segment on page 294.
Add clips using video-only or audio-only mode
By default, whenever you add clips from an event to the Timeline, all of the video and audio 
components of the event clip are included in the edit. However, you can also add just the video 
portion or just the audio portion of event clips to the Timeline, even if the event clips contain 
both video and audio.
Make video-only or audio-only edits
1 To set the edit mode, do one of the following:
• To add just the video from your selection to the Timeline: Choose Video Only from the Edit 
pop-up menu in the toolbar (or press Shift-2). 
• To add just the audio from your selection to the Timeline: Choose Audio Only from the Edit 
pop-up menu in the toolbar (or press Shift-3). 
The edit buttons in the toolbar change their appearance to indicate the mode you selected:
Video-only mode
Audio-only mode
2 Add clips to the Timeline as you normally would.
The video-only or audio-only clip appears in the Timeline.
To return to the default (video and audio) mode, choose All from the Edit pop-up menu in the 
toolbar (or press Shift-1).Chapter 8 Edit your project 115
Remove clips from your project
When you remove clips from a project in the Timeline, the source media in events, the 
Final Cut Pro media browsers, and the Finder is not affected.
Delete clips or ranges from the Timeline
1 In the Timeline, select the clips or the range you want to remove. 
2 Choose Edit > Delete (or press the Delete key).
The selected clips or portions of clips are removed from the Timeline and any clips to the right of 
the selection ripple to close the resulting gap.
To undo the deletion immediately, choose Edit > Undo (or press Command-Z).
Note: Normally, if you select an entire Timeline clip (for example, with the C key) or a range 
that consists of an entire clip (for example, with the X key) and delete it, any connected clips or 
storylines are also deleted. However, it’s possible to delete a clip without affecting its connected 
clips by holding down the Grave Accent (`) key while pressing the Delete key. For more 
information, see “Move, trim, or delete clips in the primary storyline without affecting connected 
clips” in Connect clips to add cutaway shots, titles, and synchronized sound effects on page 103. 
Also, if you delete a partial range of a clip that includes a connected clip or storyline, the 
connected items are not deleted but are instead shifted to the closest primary storyline clip.
Delete clips or ranges without affecting the total project duration and timing
If you want to remove clips from the Timeline but still maintain the total project duration and 
timing, you can replace clips with gap clips. This method prevents any ripple edits.
1 Select the clips or range you want to remove.
2 Choose Edit > Replace with Gap (or press Shift-Delete).
Final Cut Pro replaces the selection in the Timeline with a gap clip.
Note: This method preserves connected clips. When you replace a clip with a gap clip, any 
connected clips will be attached to the resulting gap clip.Chapter 8 Edit your project 116
Solo, disable, and enable clips
Sometimes, it’s helpful to compare how a sequence plays with and without certain clips. In 
Final Cut Pro, you can quickly play one clip’s audio, excluding audio from other clips. This feature, 
called solo, works by disabling the audio in all unselected clips in the Timeline. You can also 
disable (rather than delete) selected clips, making them invisible and silent during playback. 
Disabled clips do not appear in any output. You can just as easily reenable them.
Solo selected items
When you want to focus on a subset of clips in the Timeline in isolation, you can select the clips 
and solo them.
1 In the Timeline, select the clips you want to isolate.
2 Do one of the following:
• Choose Clip > Solo (or press Option-S).
• Click the Solo button in the upper-right corner of the Timeline.
When solo is turned on, the Solo button turns yellow, and nonsoloed clips are shown in black 
and white, making the soloed clips outlined in yellow easy to identify.
3 To turn off solo, click the Solo button again.
Disable and reenable one or more clips
1 Select one or more clips in the Timeline.
2 Choose Clip > Disable (or press V).
Disabled clips are dimmed in the Timeline and are invisible and silent during playback.
Disabled clip Enabled clip
3 To reenable the disabled clips, select them in the Timeline and choose Clip > Disable (or press V). Chapter 8 Edit your project 117
Find a Timeline clip’s source clip
You can quickly find the source event clip for any clip you’re using in your project in the Timeline. 
This is particularly useful if you want to duplicate a clip in your project or add the same clip to a 
different project.
Find and reveal the source event clip for a Timeline clip
1 In the Timeline, select the clip whose source event clip you want to locate.
2 Do one of the following:
• Choose Clip > Reveal in Event Browser (or press Shift-F).
• Control-click the clip and choose Reveal in Event Browser from the shortcut menu.
A selection border appears around the source clip in the Event Browser, and the playhead 
position in the source clip matches the playhead position in the Timeline clip.
Arrange clipsin the Timeline
In Final Cut Pro, you can arrange and reorder the clips in your project however you want. If you 
add or move a clip in the Timeline by dragging, Final Cut Pro moves other clips to make room for 
it. Other reordering techniques include moving clips numerically by entering a timecode value, 
nudging clips with keyboard shortcuts, overwriting with the Position tool, and moving clips 
vertically from and to the primary storyline.
Move clips by dragging horizontally
m In the Timeline, select one or more clips and drag them to a new location in the project. 
As you drag your clips, you see an outline of your selection at the new position in the Timeline. 
When you release the mouse button, the repositioned clip (or clips) appears at the new location. 
Final Cut Pro ripples clips (and any connected clips) in the Timeline to make room for the 
repositioned clips and to close the gap left by the clips that were repositioned. You can also drag 
clips vertically in and out of the primary storyline.
Note: This method of moving clips horizontally is the functional equivalent of a shuffle edit in 
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Move clips by entering a timecode value
You can move selected clips in the Timeline by entering an amount of time you want the clips 
to move.
1 Select one or more clips in the Timeline.
2 Do either or both of the following:
• To move the clips forward: Press the Plus Sign (+) key, and type a timecode duration for 
the move.
• To move the clips back: Press the Hyphen (-) key, and type a timecode duration for the move.
Note: For more information and tips on entering timecode, see Navigate using timecode on 
page 144.
The timecode entry field (with blue numbers) appears in the Dashboard in the toolbar as 
you type.
Timecode entry field 
in the Dashboard
3 Press Return.
The clips move forward or back by the duration you entered and overwrite any clips at the new 
location. If the selected clips are in a storyline, a gap clip fills in vacated parts of the storyline.
The clip moves forward 
or back by the duration 
you entered.
A gap clip fills the 
vacated part of 
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Nudge clips with keyboard shortcuts
The nudging feature in Final Cut Pro allows you to move selected items by very small amounts, 
such as frames or subframes (for connected audio-only clips).
1 Select one or more clips in the Timeline.
2 To nudge the clips, do any of the following:
• To move the selection left by one frame: Press Comma (,).
• To move the selection left by 10 frames: Press Shift-Comma (,).
• To move the selection right by one frame: Press Period (.).
• To move the selection right by 10 frames: Press Shift-Period (.).
3 If you want to nudge connected audio clips by one or more subframes, do any of the following:
• To move the selection left by one subframe: Press Option-Comma (,).
• To move the selection left by 10 subframes: Press Shift-Option-Comma (,).
• To move the selection right by one subframe: Press Option-Period (.).
• To move the selection right by 10 subframes: Press Shift-Option-Period (.).
For more information about subframes, see View audio waveforms at the audio sample level on 
page 163.
The moved clips overwrite any clips at the new location. A gap clip fills in vacated parts of 
the Timeline.
Overwrite clips using the Position tool
You can move clips by dragging them in the Timeline to overwrite other clips. This allows you to 
place clips precisely without causing other clips to move to make room.
1 Choose the Position tool from the Tools pop-up menu in the toolbar (or press P).
The pointer changes to the Position tool icon.
Tip: To switch to the Position tool temporarily, hold down the P key. When you release the P key, 
the tool reverts to the previously active tool.Chapter 8 Edit your project 120
2 Select the clip you want to move.
3 Drag the clip to a new position in the Timeline.
The moved clip overwrites any clips at the new position. A gap clip fills in the vacated part of 
the Timeline.
Note: If you prefer to move clips left or right in the Timeline without leaving a gap, you may want 
to perform a slide edit. 
To return to the Select tool (the default), choose it from the Tools pop-up menu in the toolbar (or 
press A).
Drag clips from and to the primary storyline
You can drag clips from and to the primary storyline. This technique employs ripple edits, which 
affect the total duration of your project. When you move a clip out of the primary storyline, it 
becomes either an individual connected clip or part of a connected storyline.
1 If the Select tool is not the active tool, choose it from the Tools pop-up menu in the toolbar (or 
press A).
2 Select one or more clips (either clips in the primary storyline or connected clips).Chapter 8 Edit your project 121
3 Do either of the following:
• To move clips out of the primary storyline: Drag the clips from the primary storyline to their new 
position as connected clips (above or below the primary storyline). 
The subsequent clips in the primary storyline ripple left to close the gap left by the clips 
you moved.
Drag the clip to its 
new position as 
a connected clip.
Subsequent clips 
ripple left to close 
the gap.
• To move clips to the primary storyline: Drag the clips from their position as connected clips to an 
edit point between two clips in the primary storyline. 
The result is effectively an insert edit: the former connected clips are inserted in the primary 
storyline and subsequent clips ripple right to make room for the new clips.Chapter 8 Edit your project 122
Note: You can drag clips from and to the primary storyline as long as there are no clips 
connected to them. If there is a connected clip, you must first move or remove the connected 
clip or use the Lift from Primary Storyline or Overwrite to Primary Storyline command.
Move clips from and to the primary storyline without rippling the project
You can move clips from and to the primary storyline without affecting the total duration of 
your project.
1 Select the clips you want to move.
2 Do either of the following:
• To move selected clips from the primary storyline to connected clips at the same Timeline position: 
Choose Edit > Lift from Primary Storyline (or press Command-Option-Up Arrow). 
New connected clip at the 
same Timeline position
A gap clip fills in the vacated 
part of the primary storyline.
Gap clips fill in the vacated parts of the primary storyline, as needed. 
• To move selected connected clips to the primary storyline: Choose Edit > Overwrite to Primary 
Storyline (or press Command-Option-Down Arrow). 
Depending on the amount of overlap on the connected clip, the Overwrite to Primary 
Storyline command either creates a split edit or overwrites any video clips at the new location 
and converts the audio portion of the overwritten clip to a connected clip. The Overwrite to 
Primary Storyline command is not available for audio-only clips.
Note: The Overwrite to Primary Storyline command works on individual connected clips 
only.To use this command on a clip in a connected storyline, first move the clip out of 
the storyline. 
You can achieve the same results by dragging clips with the Position tool.Chapter 8 Edit your project 123
Cut and trim clips
Trimming overview
After you’ve roughly assembled your clips in chronological order in the Timeline, you begin to 
fine-tune the cut point (or edit point) between each pair of contiguous clips. Any time you make 
a clip in a project longer or shorter, you’re trimming that clip. However, trimming generally refers 
to precision adjustments of anywhere from one frame to several seconds. If you’re adjusting clip 
durations by much larger amounts, you’re still trimming, but you may not be in the fine-tuning 
phase of editing yet.
In Final Cut Pro, you can use a variety of techniques to trim Timeline clips and edit points, 
including ripple edits, roll edits, slip edits, and slide edits.
No matter how you trim or make other edits in Final Cut Pro, the underlying media is never 
touched. Trimmed or deleted pieces of clips are removed from your project only, not from the 
source clips in your Event Library or from the source media files on your hard disk.
Tip: You can see a “two-up” display in the Viewer as you trim edit points in the Timeline. For more 
information, see Show detailed trimming feedback on page 138.
Cut clips with the Blade tool
Once you’ve added clips to the Timeline, you can easily cut them to adjust their durations or to 
remove unwanted sections.
The most basic edit is a straight cut. The term comes from the film editing process of cutting a 
filmstrip with a razor and attaching a new “clip” with glue.
Each time you cut a clip in your project, it is split into two clips. You can cut one clip at a time or 
multiple clips at a time. 
Cut a clip in the Timeline
1 Choose the Blade tool from the Tools pop-up menu in the toolbar (or press B).
The pointer changes to the Blade tool icon .
Tip: To switch to the Blade tool temporarily, hold down the B key. When you release the B key, 
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2 Move the skimmer to the frame in the clip where you want to cut, and click.
Blade tool
Tip: You can also cut clips while playing back your project. To cut clips on the fly, press 
Command-B at any time while your project plays back.
An edit point appears where you clicked, and the clip is divided into two clips.
New edit point
Cut all clips at once
You can use the Blade All command to cut all primary storyline clips and connected clips at the 
skimmer or playhead location simultaneously.
1 In the Timeline, move the skimmer to the frame where you want to cut.
2 Choose Edit > Blade All (or press Command-Shift-B).
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Cut multiple selected clips at once
You can use the Blade command to cut selected primary storyline clips and connected 
clips simultaneously.
1 In the Timeline, select the clips you want to cut.
2 Move the skimmer to the frame where you want to cut.
3 Choose Edit > Blade (or press Command-B).
The selected clips are cut at the skimmer position.
Note: If you don’t make a selection, this command acts only on the clip in the primary storyline.Chapter 8 Edit your project 126
Extend or shorten a clip
You can trim a clip in your project by adjusting the start point or end point of the clip. 
The default type of trim in Final Cut Pro is a ripple trim, which adjusts a clip’s start point or end 
point without leaving a gap in the Timeline. The change in the clip’s duration ripples outward, 
moving all subsequent clips earlier or later in the Timeline. 
A B C
A B C
Before edit
After edit
Similarly, if you delete a clip from the Timeline, subsequent clips ripple earlier to close the gap. 
Ripple edits affect the trimmed clip, the position of all subsequent clips in the Timeline, and the 
total duration of your project. 
You can see a “two-up” display in the Viewer as you trim edit points in the Timeline. This display 
shows a more detailed view of each side of an edit point. For more information, see Show 
detailed trimming feedback on page 138.
Drag edit points with the Select tool
1 In the Timeline, move the pointer to the start point or the end point of the clip you want to trim.
The pointer changes from an arrow icon to a trim icon. The look of the trim icon changes 
to indicate whether the trim will affect the end point of the left clip or the start point of the 
right clip.
Trim the left 
clip’s end point.
Trim the right 
clip’s start point.
2 Drag the start point or the end point in the direction you want to trim the clip.
As you drag, the clip shortens or lengthens. Numerical timecode fields indicate the duration of 
the clip and the amount of time you are moving the edit point.
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When you extend a clip to its maximum length in either direction, the clip edge turns red. 
Enter a new duration for a clip using timecode
You can change the total duration of one or more selected clips by entering a timecode value. 
1 Select one or more clips in the Timeline.
2 Do one of the following:
• Choose Modify > Change Duration (or press Control-D).
• Double-click in the center of the Dashboard in the toolbar. 
The timecode entry field appears in the Dashboard.
3 Enter a new duration for the selected clip.
Final Cut Pro moves the end point of the clip to the duration you entered, and any subsequent 
Timeline clips ripple accordingly. 
For more information about entering timecode values, see Navigate using timecode on page 144.
Note: If you enter a duration longer than the available media in the clip, Final Cut Pro extends 
the duration to the maximum length of the clip.
Trim to a selection
1 In the Timeline, select the part of a clip that you want to keep.
Original clip
Range selection
For information about making range selections, see Select a range on page 93.Chapter 8 Edit your project 128
2 Choose Edit >Trim to Selection.
Final Cut Pro trims the clip start and end points to the range selection.
Trimmed clip
The unwanted sections are removed from the clip and the project, and the subsequent clips in 
the project ripple accordingly.
Nudge edit points with keyboard shortcuts
You can fine-tune the start or end point of a clip using keyboard shortcuts. You can move the 
edit point by one or more video frames, and you can also move the edit points of connected 
audio clips (those not in the primary storyline) by subframes.
1 In the Timeline, select the start or end point of the clip you want to trim.
2 To move the edit point, do any of the following:
• To move the edit point left by one frame: Press Comma (,).
• To move the edit point left by 10 frames: Press Shift-Comma (,).
• To move the edit point right by one frame: Press Period (.).
• To move the edit point right by 10 frames: Press Shift-Period (.).
3 If you want to move the edit point of connected audio clips by one or more subframes, do any of 
the following:
• To move the edit point left by one subframe: Press Option-Comma (,).
• To move the edit point left by 10 subframes: Press Shift-Option-Comma (,).
• To move the edit point right by one subframe: Press Option-Period (.).
• To move the edit point right by 10 subframes: Press Shift-Option-Period (.).
For more information about subframes, see View audio waveforms at the audio sample level on 
page 163.
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Move edit points to the playhead
You can adjust selected edit points in the Timeline, either as a ripple edit or a roll edit, using 
keyboard shortcuts. 
1 In the Timeline, select the edit point you want to adjust.
Selected end point
Note: For a roll edit, select both sides of the edit point with the Trim tool.
2 Position the playhead or the skimmer at the point in the Timeline to which you want to move 
the edit point.
Skimmer
3 Choose Edit > Extend Edit (or press Shift-X).
The edit point is extended (or shortened) to the playhead or skimmer position.
The clip’s end point is extended 
to the skimmer position, and 
subsequent clips ripple right.
In the example above, if you selected the end point of the clip, subsequent clips in the Timeline 
are rippled accordingly. If you selected both sides of the edit point with the Trim tool, the right 
clip is shortened (with a roll edit) and no clips ripple.Chapter 8 Edit your project 130
Trim edit points using timecode
You can trim clips numerically by entering timecode values.
1 If the Select tool is not the active tool, choose it from the Tools pop-up menu in the toolbar (or 
press A).
2 In the Timeline, select the start point or the end point of the clip you want to trim.
3 To trim the edit point, do one of the following:
• To move the edit point forward: Press the Plus Sign (+) key, type a timecode duration for the 
trim, and press Enter.
• To move the edit point back: Press the Minus Sign (–) key, type a timecode duration for the trim, 
and press Enter.
The timecode entry field (with blue numbers and the plus or minus sign) appears in the 
Dashboard in the toolbar as you type.
Timecode entry field
The clip is shortened or extended by the amount of time you entered, and subsequent clips in 
the Timeline are rippled accordingly.
Note: You cannot use this feature to extend a clip beyond its maximum duration.
For more information and tips on entering timecode, see Navigate using timecode on page 144.Chapter 8 Edit your project 131
Cut the start or end of a clip at the playhead
Some of your video clips may have sections at the beginning or the end that you don’t want to 
include in your project. You can easily trim off these ranges with a single command, even while 
playing back the project. No selections are required. This type of edit is sometimes called a top 
and tail edit.
1 In the Timeline, position the playhead or the skimmer on the frame at which you want to trim 
the clip.
Skimmer
Original clip
2 Do one of the following:
• To trim off the start of the clip: Choose Edit > Trim Start, or press Option-Left Bracket ([).
• To trim off the end of the clip: Choose Edit > Trim End, or press Option-Right Bracket (]).
The clip is trimmed to the playhead (or skimmer) position, and the Timeline updates accordingly.
New end point 
of the trimmed clip
Trimmed clip
In the case of connected clips or storylines, Final Cut Pro trims the selected clip. If there is no 
selection, Final Cut Pro trims the topmost clip.Chapter 8 Edit your project 132
Make roll edits with the Trim tool
A roll edit adjusts the start point and the end point of two adjacent clips simultaneously. If you 
like where two clips are placed in the Timeline, but you want to change when the cut point 
happens, you can use the Trim tool to roll the edit point between the two clips. No clips move in 
the Timeline as a result; only the edit point between the two clips moves. No other clips in the 
project are affected.
When you perform a roll edit, the overall duration of the project stays the same, but both clips 
change duration. One gets longer while the other gets shorter to compensate.
A B C
A B C
Before edit
After edit
In the example above, clip B gets shorter while clip C becomes longer, but the combined 
duration of the two clips stays the same.
You can see a “two-up” display in the Viewer as you trim edit points in the Timeline. This display 
shows a more detailed view of each side of an edit point. For more information, see Show 
detailed trimming feedback on page 138.
Roll an edit point
1 Choose the Trim tool from the Tools pop-up menu in the toolbar (or press T).
The pointer changes to the Trim tool icon .
Tip: To switch to the Trim tool temporarily, hold down the T key. When you release the T key, the 
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2 In the Timeline, click the center of the edit point you want to roll so that both sides of the edit 
point are selected.
3 Do one of the following:
• Drag the edit point left or right.
• Press the Plus Sign (+) key or the Minus Sign (–) key followed by the timecode duration to add 
or subtract from the current edit, and press Return.
The timecode entry field (with blue numbers) appears in the Dashboard in the toolbar as 
you type.
For more information about entering timecode values, see Navigate using timecode on 
page 144. 
• Position the playhead or skimmer at a point in the Timeline to which you want to move the 
edit point, and choose Edit > Extend Edit (or press Shift-X).
The edit point is rolled to the new location. The combined duration of the two clips stays 
the same.
If you can’t roll the edit point any farther and one side of the edit point appears red, you’ve 
reached the end of the media for one of the two clips.Chapter 8 Edit your project 134
Make slip edits with the Trim tool
Performing a slip edit doesn’t change a clip’s position or duration in the Timeline, but instead 
changes what portion of the clip’s media appears in the Timeline. A slip edit allows you to 
change a clip’s start and end points simultaneously.
Whenever you arrange clips in the Timeline so that edit points line up with musical beats or 
other fixed sync points in a movie, you want to keep your clips in position to maintain the 
alignment. These situations leave you with very little room to adjust a clip because you cannot 
change its duration or move it elsewhere in the Timeline. All you can do is move both the start 
and end points of the clip simultaneously, keeping the clip’s position and duration fixed.
The portion of the clip seen in the project changes, but its position in the Timeline stays the 
same. Surrounding clips are not affected, and the overall duration of your project doesn’t change.
00:00:10:00 00:00:30:00
A B C
Before edit
00:00:17:00 00:00:37:00
After edit
A B C
In the example above, the slip edit changes the start and end points of clip B, but not its duration 
or position in the Timeline. When the project plays back, a different portion of clip B’s media 
is shown.
Note: To slip a clip, it must have media handles on both sides, meaning that there must be 
additional media available on both the head and the tail of the clip. If you’re having trouble 
slipping a clip, check that the clip has media handles on both sides. You can double-click any 
edit point to view or adjust its media handles in the Precision Editor.
If there are no media handles available, consider using the Position tool instead. For more 
information about the Position tool, see Arrange clips in the Timeline on page 117.
For more accurate visual feedback on edits involving contiguous clips, you can turn on “Show 
detailed trimming feedback” in Final Cut Pro preferences. For a slip edit, this “two-up” display in 
the Viewer shows the start and end points of the clip you’re slipping. For more information, see 
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Slip a clip in the Timeline
1 Choose the Trim tool from the Tools pop-up menu in the toolbar (or press T).
The pointer changes to the Trim tool icon .
Tip: To switch to the Trim tool temporarily, hold down the T key. When you release the T key, the 
tool reverts to the previously active tool.
2 Drag a clip left or right.
As you drag, a timecode field indicates the amount of time you’re moving the start point and the 
end point. Yellow edge selections on the start point and end point indicate a slip edit.
New position of frame
Yellow edge selections on the start 
point and end point indicate a slip edit.
Original position of frame
When you release the mouse button, the slipped clip appears in the Timeline with a new start 
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With the current selection, you can also slip the clip with keyboard shortcuts by doing either of 
the following: 
• Nudge the start and end points (one frame or 10 frames) to the left or right.
• Enter an amount of time to slip the clip left or right.
Note: If either the start point or the end point turns red as you drag, you’ve reached the end of 
the available media for that side of the clip.
Make slide edits with the Trim tool
Performing a slide edit allows you to move a clip’s position in the Timeline between two other 
clips without creating a gap. The clip’s content and duration remain the same; only its position 
in the Timeline changes. When you slide a clip, the adjacent clips get longer and shorter to 
accommodate the change in the clip’s position. The combined duration of these three clips stays 
the same, and the project’s total duration remains unchanged as well.
A B C
A B C
Before edit
After edit
Note: To slide a clip between two others, the preceding clip and the following clip must have 
media handles, additional media available beyond the edit point. You can double-click any edit 
point to view or adjust its media handles in the Precision Editor.
If there are no media handles available, consider using the Position tool instead. For more 
information about the Position tool, see Arrange clips in the Timeline on page 117.
For more accurate visual feedback on edits involving contiguous clips, you can turn on “Show 
detailed trimming feedback” in Final Cut Pro preferences. For a slide edit, this “two-up” display 
in the Viewer shows the two edit points you are adjusting: the end point of the preceding clip 
and the start point of the subsequent clip. For more information, see Show detailed trimming 
feedback on page 138.Chapter 8 Edit your project 137
Slide a clip in the Timeline
1 Choose the Trim tool from the Tools pop-up menu in the toolbar (or press T).
The pointer changes to the Trim tool icon .
Tip: To switch to the Trim tool temporarily, hold down the T key. When you release the T key, the 
tool reverts to the previously active tool.
2 Option-drag a clip to the left or right.
Yellow selections on the neighboring clips indicate a slide edit.
Original Timeline position
Yellow selections on the neighboring 
clips indicate a slide edit.
As you drag, a timecode field indicates the amount of time you’re moving the clip in 
the Timeline.
This clip’s duration is the same. 
This clip is longer. This clip is shorter.
New Timeline position
When you release the mouse button, the slide clip appears at the new position in the Timeline. 
The adjacent clips are trimmed to accommodate the change in the clip’s position.Chapter 8 Edit your project 138
With the current selection, you can also slide the clip with keyboard shortcuts by doing either of 
the following: 
• Nudge it (one frame or 10 frames) to the left or right.
• Enter an amount of time to slide the clip left or right.
For more information, see Arrange clips in the Timeline on page 117.
Note: If either edit point turns red as you drag, you’ve reached the end of the available media for 
that side of the clip.
Show detailed trimming feedback
For more accurate visual feedback on edits involving contiguous or connected clips, you can turn 
on “Show detailed trimming feedback” in Final Cut Pro preferences. For example, for a simple 
ripple trim, this “two-up” display in the Viewer shows the end point of the left clip and the start 
point of the right clip.
This display is available for ripple, roll, slip, and slide edits as well as for trimming in the 
Precision Editor.
Turn on detailed trimming feedback
1 Choose Final Cut Pro > Preferences, or press Command-Comma (,).
2 Click Editing.
3 In the Timeline section, select the “Show detailed trimming feedback” checkbox. 
The “two-up” display appears in the Viewer whenever you use a supported edit type or when 
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Tip: You can use the Option key to change the detailed trimming feedback display on the fly. If 
detailed trimming feedback is enabled, press the Option key to disable it. If detailed trimming 
feedback is disabled, press the Option key to switch the view between the end point of the left 
clip and the start point of the right clip.
View and navigate
Zoom and scroll in the Timeline
Being able to see and get to any point in your project is critical to efficient editing and 
storytelling. There are many ways to adjust the view of the Timeline. Learning keyboard shortcuts 
can save you time.
Fit the entire contents of the Timeline into the available window size
Whether you’re zoomed in to a single clip or zoomed out so far that all the clips in your project 
appear on the left side of the Timeline, you can quickly change the view so that all the clips fill 
the visible part of the Timeline and no scrolling is required.
m Choose View > Zoom to Fit (or press Shift–Z).
Before choosing Zoom to Fit
After choosing Zoom to Fit
Zoom in to and out of the Timeline using the Zoom slider
m To zoom in to the Timeline: Drag the Zoom slider to the right, or press Command–Plus Sign (+).
m To zoom out of the Timeline: Drag the Zoom slider to the left, or press Command–Minus Sign (–).Chapter 8 Edit your project 140
Zoom in to and out of the Timeline using the Zoom tool
1 Choose the Zoom tool from the Tools pop-up menu in the toolbar (or press Z).
The pointer changes to the Zoom tool icon .
Tip: To switch to the Zoom tool temporarily, hold down the Z key. When you release the Z key, 
the tool reverts to the previously active tool.
2 Do one of the following:
• To zoom in to the Timeline: Click the section of the Timeline you want to zoom in to. (You can 
also drag over an area of the Timeline to zoom in to just that area.)
Click multiple times to continue zooming in.
• To zoom out of the Timeline: Option-click the section of the Timeline you want to zoom out of.
Option-click multiple times to continue zooming out.
Scroll a zoomed-in Timeline
1 Zoom in to the Timeline until you see a portion of the project only.
2 Do one of the following:
• Drag the slider at the bottom of the Timeline left or right.
• Drag the slider at the right side of the Timeline up or down.
• Choose the Hand tool from the Tools pop-up menu in the toolbar (or press H), and drag in 
the Timeline. 
Tip: To switch to the Hand tool temporarily, hold down the H key. When you release the H key, 
the tool reverts to the previously active tool.Chapter 8 Edit your project 141
Adjust Timeline settings
In Final Cut Pro, it’s very easy to adjust the Timeline display options. For example, you can show 
clips with or without video filmstrips or audio waveforms. Or you can change the vertical height 
of the clips or the size of filmstrips or audio waveforms in relation to the video thumbnails that 
appear in the filmstrip of each clip in the Timeline. You can also show only the clip labels.
The snapping behavior makes it easier and quicker to do things like line up a video clip with an 
audio clip, or align the playhead to a particular marker. When snapping is turned on, items you 
move in the Timeline appear to jump, or “snap,” directly to certain points in the Timeline. This can 
help you quickly line up edits with other items in the project. 
Snapping affects the functions of many of the editing tools in Final Cut Pro, including the 
Select tool, the Trim tool, the Position tool, the Range Selection tool, and the Blade tool. Several 
elements trigger snapping in the Timeline:
• Clip boundaries (start and end points)
• The playhead and the skimmer
• Markers
• Keyframes
• Range selections
Adjust Timeline clip appearance and height
1 Click the Clip Appearance button in the lower-right corner of the Timeline.
The Clip Appearance window appears.
2 Do one of the following:
• To display clips with large audio waveforms only: Click the leftmost Clip Appearance button (or 
press Option-Control-1).
• To display clips with large audio waveforms and small filmstrips: Click the second Clip 
Appearance button from the left (or press Option-Control-2).Chapter 8 Edit your project 142
• To display clips with audio waveforms and video filmstrips of equal size: Click the third Clip 
Appearance button from the left (or press Option-Control-3).
• To display clips with small audio waveforms and large filmstrips: Click the third Clip Appearance 
button from the right (or press Option-Control-4).
• To display clips with large filmstrips only: Click the second Clip Appearance button from the right 
(or press Option-Control-5).
• To display clip labels only: Click the rightmost Clip Appearance button (or press 
Option-Control-6).
Tip: To increase the size of audio waveforms for Timeline clips, press Option–Control–Up Arrow. 
To decrease the size of audio waveforms for Timeline clips, press Option–Control–Down Arrow.
3 To adjust the vertical height of clips in the Timeline, drag the Clip Height slider to the left to 
decrease the clip height, or to the right to increase the clip height.
4 To turn connection lines for connected clips and storylines on or off, select or deselect the Show 
Connections checkbox.
5 To adjust the clip label display, choose an option from the Show pop-up menu:
• To view clips by name: Choose Clip Names.
• To view clips by role: Choose Clip Roles.
• To view multicam clips by the name of the active video angle and the active audio angle: Choose 
Clip Names or Angles.
Enable or disable snapping
While snapping is extremely useful, it can also be a hindrance if you’re trying to move a clip only 
a few frames among a series of markers and clip boundaries, and you don’t want it to snap to 
any of these points. Fortunately, you can turn snapping on or off at any time, even while you’re 
dragging a clip.
Do one of the following:
m Choose View > Snapping (or press N).
A checkmark indicates that snapping is on. You can press N to turn snapping on or off while 
you’re dragging a clip.
m Click the Snapping button in the upper-right corner of the Timeline.Chapter 8 Edit your project 143
When snapping is on, the Snapping button appears blue.
Tip: To turn snapping on or off temporarily, hold down the N key. When you release the N key, 
snapping reverts to the previous state.
Navigate within your project
The ability to jump to any point in the Timeline instantly is one of the main benefits of a 
nonlinear editing environment. Final Cut Pro provides a variety of quick and easy ways to 
navigate your project.
You can also use a text-based view of the Timeline to navigate and search your project. For more 
information, see Use the Timeline Index to view, navigate, and search your project on page 145.
You can use the J, K, and L keys to play through a project with different speeds or directions. For 
more information, see Play back media on page 74.
Navigate by skimming, clicking, or dragging
m To skim to a frame in your project: Move the skimmer left and right over the clips in the Timeline 
to quickly view them in the Viewer.
m To move the playhead to a frame in your project: Move the playhead by clicking or dragging in the 
ruler at the top of the Timeline, or by clicking in the Timeline background.
Tip: To prevent the playhead from moving while you select a clip in the Timeline, press Option as 
you click.
Navigate frame by frame
To make it easier to find specific frames in a clip, you can step through the filmstrip frame by 
frame, rather than skimming it. 
1 In the Timeline or the Event Browser, move your pointer over a filmstrip and click. 
2 Do either of the following:
• To move backward in one-frame increments: Choose Mark > Previous > Frame (or press the Left 
Arrow key).
• To move forward in one-frame increments: Choose Mark > Next > Frame (or press the Right 
Arrow key).
Navigate by subframe
You can navigate clips by subframe. A subframe has 1/80 the duration of a video frame and is a 
more precise unit of reference when viewing or editing audio waveforms that are zoomed in to 
the sample level.
Note: You can’t make edits to video at the subframe level.
1 In the Timeline or the Event Browser, move your pointer over a clip and click.
2 Do either of the following:
• To move backward in one-subframe increments: Press Command-Left Arrow.
• To move forward in one-subframe increments: Press Command-Right Arrow.
Note: You can change the time display in the Dashboard to show subframes. For more 
information, see Editing preferences on page 418.Chapter 8 Edit your project 144
Navigate by jumping
Use the following techniques to move the playhead quickly from point to point in the Timeline.
m To go to the next edit point: Choose Mark > Next > Edit (or press the Down Arrow key), or click the 
Next Edit button below the Viewer.
m To go to the previous edit point: Choose Mark > Previous > Edit (or press the Up Arrow key), or click 
the Previous Edit button below the Viewer.
m To go to the start of the project: Choose Mark > Go to > Beginning (or press the Home key).
m To go to the end of the project: Choose Mark > Go to > End (or press the End key).
m To go to the next marker: Choose Mark > Next > Marker, or press Control–Apostrophe (’).
m To go to the previous marker: Choose Mark > Previous > Marker, or press Control–Semicolon (;).
For more information about markers, see Markers overview on page 149.
Navigate using timecode
Timecode is a signal recorded with your video that uniquely identifies each video frame. When 
you play a clip from the Event Browser, its timecode signal appears in the Dashboard, in the 
center of the Final Cut Pro toolbar, using this format:
Timecode
Hours
Minutes
Seconds
Frames
Timecode supports a variety of functions in Final Cut Pro, including Timeline playback, 
synchronizing video and audio clip items, and adding, trimming, and moving clips. In addition, 
timecode allows you to navigate through projects in the Timeline and see the duration of clips, 
range selections, and projects.
Navigate by entering timecode
To move the playhead to a new Timeline location, do either of the following:
m To move the playhead to a specific Timeline location: Click once in the center of the Dashboard (or 
press Control-P), enter the new timecode value, and press Return. 
For example, to move the playhead to 01:40:31:03, press Control-P, and then enter “1403103” and 
press Return.
m To move the playhead by a timecode duration: Make sure no clips are selected, and press the Plus 
Sign (+) or Minus Sign (–) key, enter the number of frames, seconds, or minutes you want to 
move the playhead, and press Return.
For example, if you type “+1612” and press Return, the playhead moves ahead 16 seconds and 
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The new timecode values appear in the Dashboard as you enter them. When you press Return, 
the playhead moves to the new Timeline location. 
Here are some tips for entering timecode values:
• You don’t have to enter the separator characters (colons). Final Cut Pro adds them 
automatically after each set of two digits. For example, if you enter “01221419,” Final Cut Pro 
interprets it as 01:22:14:19 (1 hour, 22 minutes, 14 seconds, and 19 frames).
• If the leftmost fields are zeroes, you don’t have to enter them. For example, if you enter “1419,” 
Final Cut Pro interprets it as 00:00:14:19. If you enter “253407,” Final Cut Pro interprets it as 
00:25:34:07.
• If the rightmost fields are zeroes, you can use periods instead. For example, to move to 
timecode 00:00:03:00, type “3.” (3 and a period). To move to 03:00:00:00, type “3...” (3 and 
three periods). Instead of a period, you can also use a comma, plus sign, minus sign, colon, 
semicolon, or ampersand. 
Note: You can change the time display in the Dashboard to show timecode, timecode and 
subframes, just frames, or just seconds. For more information, see Editing preferences on 
page 418.
Use the Timeline Index to view, navigate, and search your project
The Timeline Index provides a text-based view of the clips and tags (various kinds of markers and 
keywords) used in your project in the Timeline. You can easily filter the Timeline Index to show 
only the items you want to see.
Clips are listed in their 
order of appearance 
in the Timeline.
You can also use the Timeline Index to navigate in the Timeline. The Timeline Index playhead 
appears in the list of items. When you play a project, the playhead moves down the list of items 
in the Timeline Index. When you select an item in the Timeline Index, the playhead automatically 
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Show or hide the Timeline Index
m Click the Timeline Index button in the lower-left corner of the Final Cut Pro main window (or 
press Command-Shift-2).
The Timeline Index appears in the lower-left corner of the Final Cut Pro window.
The Timeline Index playhead 
moves in tandem with the 
Timeline playhead.
Timeline playhead
View a list of items in the Timeline Index
1 If the Timeline Index is not already open, click the Timeline Index button in the lower-left corner 
of the Final Cut Pro main window (or press Command-Shift-2).
2 Do any of the following: 
• To view a list of the clips used in the Timeline, ordered chronologically: Click the Clips button at 
the top.
You can do any of the following:
• Rename clips.
• See a list of clips by timecode in the Position column.
• View, reassign, and edit roles in the Roles column.
• View and add notes in the Notes column.
• View the active angles of multicam clips in the Active Angle column.Chapter 8 Edit your project 147
You can specify which columns are displayed by Control-clicking a column heading and 
choosing an option from the shortcut menu.
You can specify which items are displayed by clicking the All, Video, Audio, or Titles button at 
the bottom of the Timeline Index. 
• To view a list of all the tags on the clips in the Timeline, ordered chronologically: Click the Tags 
button at the top.
Incomplete to-do item
Keyword
Completed to-do item
Chapter marker
Standard marker
All of the tags are shown by default. You can specify which items are displayed by clicking 
a button at the bottom of the Timeline Index. You can show markers, keywords, analysis 
keywords, incomplete to-do items, completed to-do items, and chapter markers. 
Note: To-do items are types of markers.Chapter 8 Edit your project 148
• To view a list of clips in the Timeline, organized by role: Click the Roles button at the top.
Select a role name in the list to highlight all clips in the Timeline with that role assigned. Select 
or deselect the checkboxes next to the roles you want to turn on or off in the Timeline. When a 
checkbox is deselected, you can’t see or hear clips with that assigned role when you play back 
your project. For more information, see View clips by role in the Timeline on page 305.
Change a To Do marker
In the Timeline Index, you can quickly change a To Do marker’s state from incomplete 
to completed.
1 If the Timeline Index is not already open, click the Timeline Index button in the lower-left corner 
of the Final Cut Pro main window (or press Command-Shift-2).
2 Click the checkbox for the To Do marker.
• If the marker was red (an incomplete to-do item), it turns green (completed).
• If the marker was green (a completed to-do item), it turns red (incomplete).
Search for items in the Timeline Index
1 If the Timeline Index is not already open, click the Timeline Index button in the lower-left corner 
of the Final Cut Pro main window (or press Command-Shift-2).
2 Click Clips to search for clips, or click Tags to search for tags.
3 Enter a term in the search field at the top of the Timeline Index. 
You can search for clips, keywords, and markers (including to-do items).
Tip: With the Timeline active, choose Edit > Find (or press Command-F). The Timeline Index 
opens with the search field active and ready for your search term.Chapter 8 Edit your project 149
Work with markers
Markers overview
Markers are reference points you can place within clips to locate, identify, annotate, and navigate 
to specific frames. In editing, markers are particularly useful for synchronizing two or more clips 
at a specific point. For example, you can use a marker to label the frame where a door slams 
and then snap a sound effect to that marker. You can use markers to flag a specific location in 
a clip with editing notes or other descriptive information. When you add chapter markers to 
specific points in your project, viewers can use the markers to quickly jump to those points in 
the movie after it’s been exported or burned to DVD or Blu-ray disc. You can also use markers 
for task management. 
Markers are classified as standard markers (blue), chapter markers (orange), to-do items (red), or 
completed to-do items (green).
Standard marker Chapter marker
To-do item Completed 
to-do item
You work with markers in the same way for clips in the Event Browser and clips in the Timeline.
Add and remove markers
It’s easy to add and remove markers. If you add markers to clips in the Event Browser, the markers 
are visible in both filmstrip view and list view. When you add clips with markers to the Timeline, 
the markers are visible in both the Timeline and the Timeline Index.
Add a marker to a clip in the Event Browser or the Timeline 
1 To specify where you want to add a marker, do one of the following:
• Skim to the location.
• Play the clip, and when the playhead reaches the location where you want to add a marker, 
press the Space bar to stop playback.
For more information about positioning the skimmer and the playhead, see Navigate within your 
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2 Do one of the following:
• To add a marker: Choose Mark > Markers > Add Marker (or press M).
Tip: To add markers on the fly, just press M while playing a clip.
• To add a marker and show the marker’s information: Choose Mark > Markers > Add Marker and 
Modify (or press Option-M).
Adding a marker this way automatically shows the marker’s information. 
The marker appears at the top of the clip in the Event Browser or the Timeline.
Note: Event clip markers also appear in the list view filmstrip and text list. 
Remove a marker
Do one of the following:
m Navigate to a marker and choose Mark > Markers > Delete Marker (or press Control-M).
m Select one or more clips, and choose Mark > Markers > Delete Markers in Selection.
m Double-click a marker to open the Marker window, and click the Delete button.
m Control-click the marker you want to remove, and choose Delete Marker from the shortcut menu.
Edit, move, and navigate to markers
You can view and edit marker information, and you can move markers within a clip or to 
different clips.
Edit marker information and change marker types
By default, new markers are blue standard markers with placeholder text. You can change the 
text at any time, and you can change the marker type to other marker types, including chapter 
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1 To view a marker’s information, do one of the following:
• Select the marker and choose Mark > Markers > Modify Marker (or press Shift-M).
• Control-click the marker and choose Modify Marker from the shortcut menu.
• Double-click the marker.
The marker’s information appears above the marker.
Chapter Marker button
To-Do Item button
Standard Marker button
2 To modify the marker, do any of the following:
• To change the descriptive text for the marker: Type the new text in the text field. (The text is 
automatically selected when the marker information appears, so you don’t need to select it.)
• To make the marker a chapter marker: Click the Chapter Marker button.
The marker turns into an orange chapter marker. For more information, see Manage chapter 
markers and their thumbnail images on page 152.
• To make the marker a to-do item: Click the To-Do Item button.
The marker turns red.
• To indicate that a to-do item is completed: Select the Completed checkbox.
The marker turns green.
Select the Completed checkbox.
To-Do Item button
• To make the marker a standard marker: Click the Standard Marker button.
The marker turns blue.
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Move or copy a marker
You can move or copy markers with the familiar Mac commands Cut, Copy, and Paste.
1 Control-click the marker you want to move or copy, and choose an option from the 
shortcut menu.
• To move the marker: Choose Cut Marker.
• To copy the marker: Choose Copy Marker.
2 Position the skimmer or the playhead where you want to move or copy the marker.
3 Choose Edit > Paste (or press Command-V).
The marker appears at the new location.
Nudge a marker one frame at a time
1 Click a marker to select it.
2 Do one of the following:
• To nudge the marker one frame to the right: Choose Mark > Markers > Nudge Marker Right, or 
press Control-Period (.).
• To nudge the marker one frame to the left: Choose Mark > Markers > Nudge Marker Left, or press 
Control-Comma (,).
Move between markers
You can move quickly from marker to marker in the Timeline or the Event Browser.
m To go to the next marker: Choose Mark > Next > Marker, or press Control-Apostrophe (’).
m To go to the previous marker: Choose Mark > Previous > Marker, or press Control-Semicolon (;).
Manage chapter markers and their thumbnail images
Chapter markers are a standard feature in DVDs, Blu-ray discs, and podcasts. You can add chapter 
markers to your project so that when you share your finished movie, viewers can use the 
markers to quickly jump to those points in the movie. Applications and devices that recognize 
Final Cut Pro chapter markers during playback include iTunes, iPod, iPhone, iPad, Apple TV, 
QuickTime Player, DVD Player, and most standard DVD and Blu-ray players.
Chapter markers make it easy for viewers to skip ahead to the section they want. They also allow 
Compressor, Apple’s professional transcoding application, and other DVD and Blu-ray authoring 
applications to create a navigable chapter list or menu, such as a chapter index menu. But even 
in simple projects without menus (such as podcasts), chapter markers provide viewers and 
listeners with the ability to quickly skip through sections of a program by using the Previous and 
Next buttons on their playback application or device.
A chapter marker thumbnail is a still image that represents a particular chapter. Final Cut Pro 
allows you to choose a specific video frame from the clip or storyline you’re marking as the 
chapter marker thumbnail image. In supported playback applications or devices, the chapter 
marker thumbnail images represent their corresponding chapters.Chapter 8 Edit your project 153
Create a chapter marker
1 Add a marker to a clip in the Timeline where you want the chapter to begin.
By default, Final Cut Pro creates a blue standard marker.
2 To change the marker to a chapter marker, double-click it and, when the marker's information 
appears, click the Chapter Marker button.
Chapter Marker button
To-Do Item button
Standard Marker button
The marker changes to an orange chapter marker.
Set the chapter marker thumbnail image
After you set a chapter marker, you can choose an appropriate video frame to represent that 
particular chapter.
1 Click the chapter marker once in the Timeline to select it.
The marker enlarges slightly to show that it's selected, and a chapter marker thumbnail pin 
appears to the right of the selected chapter marker. By default, the chapter marker thumbnail pin 
appears 11 frames after the chapter marker. 
Chapter marker
Chapter marker 
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2 To set the video frame for the chapter marker thumbnail image, drag the pin left or right in 
the Timeline.
As you drag, the Viewer displays the corresponding video frame.
Drag the pin left 
or right in the Timeline.
Note: The chapter marker thumbnail image is the composited image from that location in the 
Timeline and includes titles and any other superimposed imagery.
If the chapter marker is in the primary storyline, you can drag the chapter marker thumbnail 
pin as far as the beginning or the end of the primary storyline. If the chapter marker is in a 
connected storyline, you can drag the chapter marker thumbnail pin as far as the beginning or 
the end of the connected storyline.
For information about sharing your completed movie, see Sharing projects overview on page 377.
Correct excessive shake and rolling shutterissues
You can smooth a clip’s shaky footage by correcting the stabilization, rolling shutter, or both.
The stabilization feature in Final Cut Pro reduces the camera motion in your video so that shaky 
parts can be played back more smoothly. At any time, you can turn off stabilization for any clip so 
that it plays as originally recorded.
Many camcorders and still cameras include CMOS image sensors that expose the picture they’re 
recording progressively, instead of all at once. As a result, if the camera moves a lot during 
recording, or if the camera is recording fast motion, image distortion can occur. This causes the 
picture to appear wobbly or skewed. Final Cut Pro has a rolling shutter feature that can reduce 
this motion distortion. 
Fix a clip with excessive shake or rolling shutter distortion
1 If the clip is not already in your project, add it to the Timeline and select it.
Note: These operations act on whole clip selections, not on range selections. To get the highestquality and fastest results, isolate the problem section by cutting the clip with the Blade tool in 
the Timeline. Then apply the correction to just the video footage that needs correcting.
2 To open the Video inspector, click the Inspector button in the toolbar (shown below), and click 
the Video button at the top of the pane that appears.
3 In the Video inspector, do either of the following:Chapter 8 Edit your project 155
• To reduce the shake: Select the Stabilization checkbox.
• To reduce rolling shutter distortion: Select the Rolling Shutter checkbox.
When you turn on Stabilization or Rolling Shutter, its checkbox turns blue.
4 To view the fix, play the clip in the Timeline.
To turn off stabilization or rolling shutter corrections for a clip, deselect the Stabilization or 
Rolling Shutter checkbox.
You can refine the corrections by adjusting the stabilization settings or the Rolling Shutter 
Amount setting.
Adjust stabilization settings
You can adjust how much of a correction is applied by the stabilization feature.
The stabilization feature has two independent phases:
• When you apply the stabilization feature to a clip, Final Cut Pro analyzes the pixels in 
successive frames to determine the direction of camera movement.
• During playback and rendering, Final Cut Pro uses the motion analysis data to apply a 
transform effect to each frame, compensating for camera movement.
Use any of the three independent stabilization parameter sliders in the Video inspector to 
control the steadiness of your shot. When you apply stabilization to a clip, all three parameters 
are set to an average value of 2.5 by default. Each parameter can be set to a value between 0.0 
and 5.0. A value of 0.0 turns off the parameter, and a value of 5.0 applies the strongest possible 
transformation. The higher you set each parameter, the more camera motion is compensated for 
in that axis.
x
Translation
y
x
Rotation
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1 Select a clip in the Timeline, and open the Video inspector.
2 Do any of the following:
• To adjust left, right, up, and down movement of a shot (x and y axes): Drag the Translation 
Smooth slider.
• To adjust rotation around the center point of the image: Drag the Rotation Smooth slider.
• To adjust forward or backward camera or lens movement (z axis): Drag the Scale Smooth slider. 
For example, if you want to remove horizontal, vertical, and rotational shake, you should set 
the Translation Smooth and Rotation Smooth parameters to a value above 0. You may need to 
experiment to see which values steady your shot the best.
Note: When a clip has too much motion (excessive panning, for example), stabilizing the clip 
may result in black bars on the edges of the video.
To avoid the black bars, you can:
• Reduce the values for the Translation Smooth, Rotation Smooth, and Scale Smooth parameters.
• Cut or trim the clip in the Timeline to remove the sections with the most shake. (You can 
locate the sections with excessive shake in the Tags pane of the Timeline Index. Click the 
individual Excessive Shake tags to select the corresponding ranges in the Timeline.)
• Crop the edges of the stabilized video to remove the black bars.157
Audio overview
Final Cut Pro has many features designed to make processing and editing audio easier. For 
example, you can use Final Cut Pro to analyze and automatically enhance audio to address 
problems such as noise or hum, add effects to your clips, synchronize video and audio clips 
automatically, and match audio between two clips.
You can make the following changes to clips or to audio components within a clip:
• Edit multiple audio channels: You can expand the audio portion of clips to reveal and edit 
audio components down to the single channel level. This allows you to apply different effects 
to different components or channels, and streamlines the process for making quick sound 
cutouts or other adjustments. See Audio editing overview on page 168.
• Adjust volume: Quickly adjust a clip’s volume directly in the Timeline or in the Audio inspector. 
See Adjust volume on page 172.
• Pan audio: Take advantage of built-in pan presets for both stereo and surround sound. See Pan 
audio on page 177.
• Add audio effects: Add Audio Units effects, Logic Effects, or custom effects included with 
Final Cut Pro, such as reverb, to clips. See Add audio effects on page 187.
• Add keyframes to automate volume and effects: Vary volume or effect settings as a clip plays. See 
Adjust audio effects using keyframes on page 192.
Note: You can create fades in clips only. To fade clips in or out with easy-to-use fade handles, see 
Fade audio in or out on page 174.
You use the same tools used for video editing when you edit audio clips in Final Cut Pro. The 
following editing features are covered elsewhere in Final Cut Pro Help:
• Change edit mode: Set the edit mode for a clip to video only or audio only. See Add clips using 
video-only or audio-only mode on page 114.
• Add markers to clips: Add markers to mark specific reference points within an audio clip. For 
more information, see Markers overview on page 149.
• Trim audio: Make precision edits to the audio waveform—for example, to take out an 
unwanted sound in the recording. See Trimming overview on page 123.
• Add audio crossfades: Create a smooth transition when connecting two separate audio 
waveforms. See Add transitions to your project on page 207.
• Use compound clips: Compound clips let you combine any video or audio clips into a single 
compound clip. From an audio standpoint, compound clips let you apply the same audio 
effect or enhancement to a group of clips, similar to applying an effect or adjustment to the 
overall mix. See Compound clips overview on page 257.
• Export audio: You can export your project as an audio file in either mono, stereo, or surround 
sound. You can also export media by role. See Sharing projects overview on page 377.
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Audio editing basics
About audio waveforms
Audio waveforms are visual representations of the actual sound. Audio waveforms appear in clips 
in the following ways:
• As the bottom portion of a video clip, colored blue
• As a detached or an audio-only clip, colored green
Audio portion of a video clip Audio-only clip
An audio waveform’s amplitude and length change according to the underlying sound’s volume 
and duration. A short, loud sound such as a drum beat has a sharp, peaked waveform, whereas 
low-level crowd noise has a lower, more uniform waveform. These properties make it easier to 
find specific edit points when trimming clips or keyframing effects.
In Final Cut Pro, audio waveforms change according to a clip’s volume level or applied effects. 
The waveform appears larger when the volume is high and smaller when the volume is low.
You edit audio clips in the Timeline by first listening to a clip’s audio through playback and 
skimming, and then applying changes to the clip, using the waveform as a reference.Chapter 9 Edit audio 159
About audio channels and audio components
Audio files can contain a single audio channel or multiple audio channels. Channels usually 
correspond to microphone inputs during recording or to speakers for multichannel output. For 
example, a stereo audio file usually contains left and right channels that match what you hear 
from the left and right speakers during playback.
Final Cut Pro automatically groups channels into audio components according to how the 
channels are configured for the clip. You can expand the audio portion of clips to view and edit 
audio components down to the individual channel level. You can then make separate volume 
or pan adjustments or apply and keyframe different audio effects for each component. For more 
information, see Audio editing overview on page 168.
The number of audio components you see corresponds to the number of channels you’ve 
configured in your source clip.
Note: Many popular digital audio file formats, such as AAC and MP3, use interleaved stereo files, 
which do not contain separate left and right channels. A stereo clip with interleaved left and 
right channels appears as a single audio component in the Audio inspector and the Timeline. If 
you change the clip’s channel configuration from Stereo to Dual Mono, the channels appear as 
two separate audio components.
Audio components
For more information about configuring audio channels, see Configure audio channels on 
page 169.
Ways to view audio clips
When you work with audio waveforms in the Timeline, you can zoom in or out or change the clip 
appearance to make the waveform taller or shorter.
Final Cut Pro also includes several ways of viewing and working with audio and video within 
clips. You can: 
• Expand a clip to view and edit audio components down to the individual channel level.
• Expand a clip to see separate audio and video.
• Detach audio from a video clip to work on the audio and video as separate clips.
• Change the background appearance of a clip to show reference waveforms, which make it 
easier to see audio waveforms when the volume is diminished.Chapter 9 Edit audio 160
Show expanded audio components
You can expand the audio portion of clips in Final Cut Pro to view and edit audio components.
You can show expanded audio components for synchronized clips, multicam clips, and 
compound clips.
Do one of the following:
m Select the clip in the Timeline, and choose Clip > Expand Audio Components (or press 
Option-Control-S).
m Double-click the audio portion of the clip in the Timeline while holding down the Option key.
Normal clip view
Audio components
Collapse audio components
Do one of the following:
m Select either the clip or one of its audio components in the Timeline, and choose Clip > Collapse 
Audio Components (or press Option-Control-S).
m Double-click any of the audio components in the Timeline while holding down the Option key.Chapter 9 Edit audio 161
Show expanded audio and video
You can view audio and video separately in the same clip in the Timeline by expanding clips that 
have both audio and video. This can be useful if you need to zoom in to the audio portion to 
make edits.
Note: If you create a split edit so that audio portions overlap, you won’t clearly see the 
overlapped waveforms unless you choose to show expanded audio for split clips.
m To expand a single clip: Double-click the audio waveform of the clip.
m To expand a clip or clips you’ve selected in the Timeline: Choose Clip > Expand Audio/Video (or press 
Control-S).
m To expand all clips in the Timeline: Choose View > Expand Audio/Video Clips, and choose for all 
clips or for split clips.
Normal clip view
Clip with expanded audio
When you show expanded audio, the audio and video portions of the clip remain attached to 
each other. To create a separate connected audio clip, detach the audio. You can also use the 
Precision Editor to see a detached view of the video and audio portions of the clip.
Collapse audio and video
You can collapse the expanded audio/video view for a single clip, multiple clips, or all clips in 
the Timeline.
m To collapse a single clip: Double-click the audio waveform of the clip.
m To collapse a clip or clips you’ve selected in the Timeline: Choose Clip > Collapse Audio/Video (or 
press Control-S).
m To collapse all expanded clips in the Timeline: Choose View > Collapse All Clips.Chapter 9 Edit audio 162
Detach audio from video
By default, Final Cut Pro imports audio and video from the same source into one clip. You 
can easily detach the audio from a video clip so that you can edit the audio clip separately in 
the Timeline.
m Select the clip in the Timeline, and choose Clip > Detach Audio.
 A new audio clip appears as a connected clip beneath the video clip.
Detached audio
To reattach an audio clip to its original video clip, you need to create a compound clip. 
Show or hide reference waveforms
A reference waveform shows the maximum visual resolution possible for the actual audio 
waveform. By factoring out loudness changes, reference waveforms let you see the details of the 
sound more clearly.
1 Choose Final Cut Pro > Preferences, and click Editing.
2 Select the “Show reference waveforms” checkbox.
Reference waveform
When the actual waveform changes shape (for example, when it is diminished because a clip’s 
volume level is low), its full reference waveform is still visible for easy reference when editing.
Tip: You can place any clip with audio either above or below the primary storyline in the 
Timeline. If your clip contains video and is placed below the primary storyline, the video may 
be obscured by the video in the primary storyline, but the audio will play. If you put the clip 
above the primary storyline, the audio plays and the video also plays (instead of the video in the 
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View audio waveforms at the audio sample level
For even more precise editing, you can zoom in to audio clips at the audio sample level. Audio 
samples show the audio waveform at a fraction of a second (for example, 1/48,000 for audio 
recorded at a sample rate of 48 kHz). Sample-accurate editing resolution is available only for 
connected audio clips (that is, audio clips not in the primary storyline) or compound clips that 
contain only audio.
Tip: For reference when working with video, you can view subframes (1/80 the duration of a 
video frame) in the timecode display of the Dashboard. In the Editing pane of Final Cut Pro 
preferences, choose the subframe option in the Time Display pop-up menu.
Zoom to audio samples
1 Choose View > Zoom to Samples (or press Option-Z).
2 Select the clip in the Timeline.
3 Zoom in until the clip shows the waveform within the borders of a video frame.
Frame borders
You can continue to zoom in for closer detail of the waveform.
Frame borders
4 Make edits to the clip or adjustments to audio effects using keyframes.
To turn off zooming to audio samples, choose View > Zoom to Samples (or press Option-Z).
Navigate by subframe
1 In the Timeline or the Event Browser, move your pointer over a clip and click.
2 Do either of the following:
• To move backward in one-subframe increments: Press Command-Left Arrow.
• To move forward in one-subframe increments: Press Command-Right Arrow.Chapter 9 Edit audio 164
View and correct audio levels
The Audio meters let you see and track the audio levels of clips in Final Cut Pro and warn you if 
a particular clip or section of a clip reaches peak levels, which may result in audible distortion.
The number of audio meters you see depends on how many channels are configured for the 
clip you’re playing. For example, when you play back a surround clip in the Event Browser, six 
surround audio meters are displayed, but if you drag that same clip into a stereo project in the 
Timeline, Final Cut Pro automatically mixes down the surround audio into stereo, and only two 
audio meters are displayed. For more information, see Configure audio channels on page 169. 
When an audio clip is approaching peak levels during playback, the level color changes from 
green to yellow.
When an audio clip exceeds peak levels, the level color changes from yellow to red, and the peak 
indicator lights red for the respective audio channel or channels. The peak indicators reset when 
you stop and start playback again. 
To avoid having clip volume exceed peak levels, adjust the volume. Although the proper level 
for a clip depends upon the overall mix you want, it’s important to make sure that the combined 
level for all concurrent clips does not exceed 0 dB during the loudest sections.
Final Cut Pro includes two meters, a small Audio Meter icon in the Dashboard in the toolbar and 
a larger Audio Meters pane.
Show or hide the Audio meters
To show the Audio meters, do one of the following:
m Choose Window > Show Audio Meters.
m Click the Audio Meter icon in the Dashboard in the toolbar.
You can drag the edges of the meters to see an expanded view with additional information.
Level 
Surround channels
Peak indicators
To hide the Audio meters, choose Window > Hide Audio Meters, or click the Audio Meter icon in 
the Dashboard in the toolbar.Chapter 9 Edit audio 165
Reset and correct peak levels
m Select the clip in the Timeline, readjust the level, and play back the clip again to test for peaks.
In the Timeline and Event Browser, the waveform section or sections of a clip turn yellow when a 
level is approaching peak levels or red when a level exceeds 0 dB. 
Solo and mute audio clips
The solo feature temporarily disables audio playback of all clips in the Timeline except for 
selected ones. It is especially useful in audio editing if you have more than one audio clip 
layered in the Timeline (dialogue and background music, for example) but need to listen and 
make edits to just certain clips.
You can also mute clips by disabling them. Disabled clips are both invisible and silent and will 
not appear in any output.
Solo clips in the Timeline
1 Select one or more clips in the Timeline.
2 Do one of the following:
• Choose Clip > Solo (or press Option-S).
• Click the Solo button in the Timeline.
Solo button
The soloed clip appears highlighted, while other clips appear dimmed.
Soloed clip
To turn off solo, click the Solo button, or choose Clip > Solo (or press Option-S) again.
Disable clips
1 Select one or more clips in the Timeline.
Note: If the selected clips contain both video and audio, and you want to mute the audio only, 
choose Clip > Detach Audio, and select the detached audio portion only.
2 Choose Clip > Disable (or press V).
Disabled clips are silent and appear dimmed in the Timeline.
3 To reenable the disabled clips, select them in the Timeline and choose Clip > Disable (or press V). 
You can solo video clips in Final Cut Pro. For more information, see Solo, disable, and enable 
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Add audio
Add music and sound
You can add music and sound files directly to your project from your iTunes library or 
other sources.
Final Cut Pro also includes a number of built-in Foley and other sound effects that you can insert 
as connected audio clips.
If you have a clip that contains both audio and video, you can change the edit mode to audio 
only to insert only the audio portion of the clip.
Add music and sound to a project in the Timeline
1 Click the Music and Sound button in the toolbar.
2 In the Music and Sound Browser, choose a source folder from the pop-up menu at the top. For 
example, choose iTunes to browse your iTunes collection.
Tip: If the folder you’re looking for doesn’t appear, you can add it to the source list by dragging it 
from the Finder or desktop to the Music and Sound Browser.
3 In the sound list that appears, find the sound or music you want:
• To search for an item: Type text in the search field. To filter your search, click the Filter button 
, and choose a filter.
• To preview an item: Double-click the item, or select the item and click the Play button .
• To select more than one item: Command-click each item.
4 Drag the sound file or files to the Timeline.
Note: For better import and playback performance, Final Cut Pro automatically transcodes 
all MP3 audio files to WAV audio files and retains the original MP3 files for future use. For 
information about where to find original and transcoded media files, see Where your media and 
project files are located on page 390.
Record audio
You can record audio directly in Final Cut Pro from input sources such as built-in and external 
microphones. The recorded audio file appears both in the Event Browser and as a connected clip 
in the Timeline.
This function is particularly useful for recording voiceover narration.Chapter 9 Edit audio 167
Record live audio
1 Position the playhead where you want to start recording in the Timeline.
2 Choose Window > Record Audio.
Click the Record button 
to start or stop recording.
3 If necessary, adjust the input parameters by doing any of the following:
• To change where the recording is saved: Choose an Event folder from the Destination 
pop-up menu.
• To change the input device or number of input channels (mono or stereo): Choose an option from 
the Input Device pop-up menu.
• To adjust the input level of the microphone: Drag the Gain slider right to increase the input level, 
or left to decrease it, using the Audio meters to view and correct audio levels.
4 If necessary, adjust the output parameters by doing any of the following:
• To hear output while recording: Select the Monitor checkbox.
Note: If both input and output sources are near each other (such as the built-in microphone 
and built-in speakers), you may experience feedback.
• To change the output device or number of output channels (mono or stereo): Choose an option 
from the Monitor pop-up menu.
• To adjust the output level: Drag the Gain slider right to increase the output level, or left to 
decrease it.
5 To start recording, click the Record button.
6 To stop recording, click the Record button again (or press the Space bar).
Your audio recordings are attached to the primary storyline at the playhead position.Chapter 9 Edit audio 168
Edit audio clips or audio components
Audio editing overview
You edit audio in Final Cut Pro in two ways, detailed below.
Clip-level audio editing
You can make audio adjustments and edits to whole clips. At this level, audio adjustments and 
effects are applied to the entire clip, including any audio channels within the clip. Final Cut Pro 
preserves any adjustments you make to individual audio channels. This means that if you reduce 
the volume for a single channel but raise the volume for the whole clip, the volume of the single 
channel is raised but stays in proportion to the volume of other channels in the clip.
If your source media contains only one or two audio channels or you’re editing an audio-only 
clip, you’ll probably only need to make adjustments and edits at this level.
Advanced multichannel audio editing
Final Cut Pro automatically groups channels into audio components according to how the 
channels are configured for the clip. You can expand the audio portion of clips to reveal and edit 
audio components down to the individual channel level. This allows you to apply different effects 
to different components and streamlines the process for making quick sound cutouts to a single 
microphone input or other fine adjustments.
Important: Many digital audio file formats, such as AAC and MP3, use interleaved stereo files, 
which do not contain separate left and right channels. These files appear as a single audio 
component unless you change the clip’s channel configuration.
Keep in mind the following when editing audio components in Final Cut Pro: 
• You view and change the audio channel configuration of your clips in the Audio inspector. 
You can change audio component names, add or remove audio components, and configure 
channels in mono, stereo, and surround formats. See Configure audio channels on page 169.
• With the Range Selection tool (the default editing tool), you can quickly select ranges within 
an audio component to target the audio you want to edit.
• You can edit audio components for synchronized clips, multicam clips, and compound clips.
• You edit audio components in the same way you edit whole clips. You can:
• Skim individual components when clip skimming and audio skimming are turned on. See 
Skim media on page 76.
• Adjust the volume of a component. See Adjust volume on page 172.
• Mute a component’s audio by disabling all or a portion of the component. This is the fastest 
way to remove unwanted sounds from a component. See Solo, disable, and enable clips on 
page 116.
• Pan the sound for individual components. See Pan audio on page 177.
• Assign a role such as Dialogue, Music, or Effects to a component in the Info inspector (or by 
using the Modify menu when the clip that contains the audio component is in the Timeline). 
See Use roles to organize clips and export audio files on page 186.
• Add or adjust audio effects for individual components. See Add audio effects on page 187 or 
Adjust audio effects on page 189.
• Adjust audio effects for individual components using keyframes. See Adjust audio effects 
using keyframes on page 192.
For examples of multichannel audio editing workflows, see Multichannel audio editing 
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Configure audio channels
Final Cut Pro assigns a default channel configuration for audio clips when they are imported 
or added to a project. You can change the channel configuration if, for example, you want to 
convert a stereo dialogue clip to two mono channels.
Final Cut Pro automatically groups channels into audio components according to how the 
channels are configured for the clip. For more information, see About audio channels and audio 
components on page 159.
In addition to changing the channel configuration, you can view and listen to audio components, 
add or remove audio components from a clip, and rename audio components.
Change the channel configuration
The number of channel options you can configure depends upon how many channels are in 
your source clip or compound clip. You can configure channels in several formats, including:
• Mono: Single channel. In a surround sound setup, you can assign a mono channel to any 
surround channel.
• Stereo: Left and right channels.
• 5.1 surround: Left, center, right, left surround, right surround, and low-frequency effects 
(subwoofer bass) channels.
• 7.1 surround: Left, center, right, left surround, right surround, left back, right back, and lowfrequency effects (subwoofer bass) channels.
If you configure more than six surround channels, Final Cut Pro automatically adjusts the channel 
mix down to 5.1 surround during playback.
Important: Changing the channel configuration resets all adjustments and edits made to audio 
components (including applied effects, disabled ranges, keyframe adjustments, and custom names).
1 Select the clip in the Timeline.
2 In the Channel Configuration section of the Audio inspector, choose an option from the 
Channels pop-up menu.
The channels appear in the Audio inspector as separate audio components, each with its 
own waveform.
If you have a clip with surround channels and want to assign a mono channel to a specific 
surround channel, select the mono channel waveform and choose a surround channel from 
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Note: To change the channel configuration of a compound clip, first deselect Use Event Clip 
Layout from the Channels pop-up menu, and then choose another configuration.
To reset a configuration, click the Reset button .
View and listen to an audio component
1 Select the clip in the Timeline.
2 In the Channel Configuration section of the Audio inspector, click the disclosure triangle next to 
the clip name to reveal its audio components, and then skim over a component or play it back 
using the Space bar or the J, K, and L keys. 
Skim to preview.
Add or remove an audio component
You can add or remove audio components in a clip. For example, you may want to remove 
unused components from a clip, or add components from inactive angles to the active angle 
in a multicam clip.
By default, all active audio components in a clip appear as selected in the Audio inspector and 
are arranged in the same order when the clip is expanded to show audio components in the 
Timeline. To learn more about viewing audio components, see Ways to view audio clips on 
page 159.
When you remove an audio component, it appears dimmed in the Audio inspector but is 
removed from the clip’s component arrangement in the Timeline.
1 Select the clip in the Timeline.
2 In the Channel Configuration section of the Audio inspector, click the disclosure triangle next to 
the clip name to reveal the clip’s audio components.
3 Do one of the following:
• To remove a component: Deselect the checkbox next to a component waveform.
• To add a component: Select the checkbox next to a component waveform.
Select to add or remove 
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Rename a component
Do one of the following:
m In the Channel Configuration section of the Audio inspector: Click the disclosure triangle next to the 
clip name to reveal the clip’s audio components, and then double-click a component’s name and 
type a new name.
Type a new audio 
component name 
in the field.
m In a clip in the Timeline with expanded audio components shown: Control-click the audio 
component, choose Rename Component from the shortcut menu, and type a new name.
To learn more about viewing audio components, see Ways to view audio clips on page 159.
Important: If you subsequently change the channel configuration, all custom audio component 
names are reset to the original name.
You can also choose a channel configuration when exporting roles as audio stems for mixing or 
post-production. For more information, see Use roles to organize clips and export audio files on 
page 186. If you choose an export file channel configuration that is different from that of your 
source files, the channels are exported in the following ways:
• Stereo source exported as surround: The left and right channels are exported to the left and 
right channels of the surround file.
• Surround source exported as stereo: The surround source is exported as a stereo (left and right 
channel) mix.
• Stereo or surround source exported as mono: The stereo or surround source is exported as a 
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Adjust volume
You can adjust the volume levels of audio clips from the Event Browser, the Timeline, the Audio 
inspector, or the Modify menu. Volume adjustments you make in the Audio inspector or from 
the Modify menu are applied to the entire selection. To make more precise adjustments, you 
can create keyframes in the clip, and then make adjustments to points between keyframes. See 
Adjust audio effects using keyframes on page 192.
You can make sure the volume doesn’t exceed peak levels, which may result in audible distortion, 
by using the Audio meters.Adjust volume in the Timeline
m Drag the volume control (the horizontal line across the audio waveform) up or down.
As you drag, the level reading in dB appears, and the waveform changes shape to reflect 
your adjustments.
Volume control
If you adjust the volume between two keyframes, the volume line slopes to show the change 
in volume between the keyframes.
Adjust volume from the Modify menu or the keyboard
1 Select one or more audio clips or video clips with audio in the Timeline.
2 Choose Modify > Volume, and choose Up or Down, or press Control-Equal Sign (=) or 
Control-Hyphen (-).
The volume is adjusted in +1 or –1 dB increments. If multiple clips are selected, the volume is 
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Adjust volume in the Audio inspector
1 Select one or more audio clips or video clips with audio in the Event Browser or the Timeline.
2 In the Audio inspector, do one of the following:
• Enter a value in the Volume field.
If multiple clips are selected, the volume for all clips is set to the value you entered.
• Drag the Volume slider right to increase the volume, or left to decrease it.
If multiple clips are selected, the volume for all clips is adjusted relative to each clip’s 
original volume.
Volume slider
Adjust volume automatically across a selected area
For volume adjustments of a clip in the Timeline, you can use the Range Selection tool to add 
keyframes automatically across a selected range.
1 Select the clip in the Timeline.
2 Choose Range Selection from the Tools pop-up menu in the toolbar (or press R).
The pointer changes to the Range Selection tool icon . 
3 Drag across the area where you want to adjust the volume.
4 Adjust the volume within the range by dragging the horizontal control up or down.
Keyframes are automatically created along the adjustment points within the range.
Reset all volume adjustments
1 Select an audio clip or video clip with audio in the Event Browser or the Timeline.
2 Click the Reset button in the Volume and Pan section of the Audio inspector.Chapter 9 Edit audio 174
Fade audio in or out
There are several ways to create fade-ins or fade-outs to the audio portion of clips in Final Cut Pro:
• Automatic crossfades during transitions: When you add a transition to a video clip with attached 
audio, Final Cut Pro automatically applies a crossfade transition to the audio. If the audio is 
detached or expanded from the video, the audio is not affected by the video transition. See 
Add transitions to your project on page 207.
• Crossfades: When trimming the audio waveform in clips, you can apply a crossfade to the edit 
point. See Trimming overview on page 123.
• Fade handles: You can quickly create fade-ins and fade-outs to the audio portion of clips in the 
Timeline by using fade handles, which appear when you place the pointer over the top-left or 
top-right corner of the audio waveform.
Fade handle Fade handle
You can also change the fade’s shape by choosing one of several predefined options. 
Changing the fade shape changes the sound of the fade.
Note: Fades created using fade handles override crossfades created by a transition.
Create a fade using fade handles
m Drag the fade handle to the point in the clip where you want the fade to begin or end.
Fade handles from the beginning of a clip create a fade-in, while fade handles at the end of a clip 
create a fade-out.
Fade-in Fade-out
Fades complement any volume adjustments you’ve already made to a clip. For example, if you 
previously adjusted the volume lower at the beginning of a clip, the fade-in increases the volume 
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Create a crossfade manually using fade handles
1 Select two adjacent clips in the Timeline, and choose Clip > Expand Audio/Video (or press 
Control-S).
The clips appear expanded.
2 Drag the end point of the first clip to the right and the start point of the second clip to the left 
so that the audio portions of the clips overlap.
Note: Make sure to adjust the audio overlap to the length you want.
3 Drag the fade handles of each clip to the points where you want the fade to begin and end.
Crossfade Fade handle
To change the fade shape for each clip, follow the instructions immediately below.Chapter 9 Edit audio 176
Change the fade shape when using fade handles
m Control-click a fade handle, and choose a fade option from the shortcut menu:
• Linear: Maintains a constant rate of change over the length of the fade.
• S-curve: Eases in and out of the fade with the midpoint at 0 dB.
• +3dB: Starts quickly and then slowly tapers off toward the end. This is the most useful setting 
for quick fades.
• –3dB: Starts slowly and then moves quickly toward the end. This is the default setting and is 
best for maintaining a natural volume when crossfading between two adjacent clips.
Change the fade shape of a transition crossfade
1 Select a transition in the Timeline, and do one of the following:
• Choose Window > Show Inspector (or press Command-4).
• Click the Inspector button in the toolbar.
2 In the Audio Crossfade section of the Transition inspector, choose a fade option from the Fade In 
Type and Fade Out Type pop-up menus:
• Linear: Maintains a constant rate of change over the length of the fade.
• S-curve: Eases in and out of the fade with the midpoint at 0 dB.
• +3dB: Starts quickly and then slowly tapers off toward the end. This is the most useful setting 
for quick fades.
• –3dB: Starts slowly and then moves quickly toward the end. This is the default setting and is 
best for maintaining a natural volume when crossfading between two adjacent clips.Chapter 9 Edit audio 177
Pan audio
Panning audio lets you distribute sound across the stereo or surround spectrum to create 
balance or a special effect. For example, you can place more sound in the right channel of a 
stereo clip or less sound in the center channel of a surround clip.
Final Cut Pro includes a built-in surround sound decoder that lets you choose among several 
stereo and surround preset pan modes that you can apply to clips from the Audio inspector. 
Using the pan mode presets, you can dynamically re-create surround sound fields from stereo 
source content.
When you change the pan mode in the Audio inspector, the setting is applied to the entire 
selection. To make more precise adjustments, you can add keyframes using the Audio Animation 
Editor or the Audio inspector, and then make adjustments to them in the Audio inspector.
Pan audio for stereo
1 Select the audio clip.
2 In the Audio inspector, choose Stereo Left/Right from the Pan Mode pop-up menu.
3 Move the sound left or right by doing one of the following:
• Type a value in the Pan Amount field.
• Drag the Pan Amount slider left or right.
Pan audio for surround sound
1 Select the audio clip.
2 In the Audio inspector, choose one of the following options from the Pan Mode pop-up menu:
• Create Space: Distributes the signal across the surround spectrum, with more signal to the 
center and front left and right channels. This setting is useful for making a general-purpose 
surround mix from any stereo source. The Pan Amount slider setting can be adjusted from 0 
(no effect) to 100 (total surround field).
• Dialogue: Pans more signal to the center channel of the surround spectrum so that the direct 
sound is in the center, while ambient sound is distributed to the other channels. This setting is 
best used for voiceover or other dialogue clips. The Pan Amount slider setting can be adjusted 
from 0 (no effect) to 100 (all sound to the center channel).
• Music: Distributes a stereo mix signal evenly across the surround spectrum. This setting is best 
used for converting stereo music to a surround mix. The Pan Amount slider setting can be 
adjusted from 0 (no effect) to 100 (total surround field).
• Ambience: Pans across the surround spectrum with more signal toward the surround channels 
and less signal to the front and center channels. This setting is useful for effects such as crowd 
noise or other outdoor environments. The Pan Amount slider setting can be adjusted from 0 
(no effect) to 100 (total surround field).
• Circle: Pans the sound in a circle around the surround spectrum like a bee buzzing around 
the listener’s head. The Pan Amount slider adjusts the direction to the listener in degrees 
(–180 to 180).
• Rotate: Pans around the surround spectrum as if the listener is turning in a circle. The Pan 
Amount slider adjusts the listener rotation in degrees (–180 to 180).
• Back to Front: Pans from back to front across the surround spectrum. The Pan Amount slider 
setting can be adjusted from –100 (back) to 100 (front).
• Left Surround to Right Front: Pans from left surround to right front across the surround spectrum. 
The Pan Amount slider setting can be adjusted from –100 (left surround) to 100 (right front).
• Right Surround to Left Front: Pans from right surround to left front across the surround spectrum. 
The Pan Amount slider setting can be adjusted from –100 (right surround) to 100 (left front).Chapter 9 Edit audio 178
3 If you want to adjust the pan amount, do one of the following:
• Type a value in the Pan Amount field.
• Drag the Pan Amount slider left or right.
The Pan Amount settings vary according to the pan mode you choose.
Adjust surround sound using the Surround Panner
In the Audio inspector, you can use the Surround Panner to change the surround sound field or 
make advanced adjustments using sliders.
Using the Surround Panner, you can change the panning levels by moving a control 
that represents where the sound would appear to originate in an actual surround sound 
speaker setup.
1 Choose a surround preset from the Pan Mode pop-up menu.
2 To open the Surround Panner, click the disclosure triangle next to Surround Panner in the 
Volume and Pan section of the Audio inspector.
Click to display the 
Surround Panner.
3 Do either of the following:
• To make adjustments in the Surround Panner: Drag the control within the surround field to pan 
toward or away from any of the surround channels (left, center, right, left surround, or right 
surround) represented by the speaker icons. Click a speaker icon to turn it on or off.
Drag to move the 
sound source.
To move the control back to the center position, double-click it.Chapter 9 Edit audio 179
• To make advanced adjustments: Click the Advanced disclosure triangle below the Surround 
Panner, and drag the sliders left or right for any of the following parameters:
• Original/Decoded: Adjusts the balance between the original and decoded signals. The slider 
can be adjusted from –100 (original signal only) to 100 (decoded center and surround signals 
only). At 0, the signal is balanced evenly between the original and decoded signals.
• Ambient/Direct: Adjusts the balance between decoded surround and center signals. The 
slider can be adjusted from –100 (surround signal only) to 100 (center signal only). At 0, the 
signal is balanced evenly between the center and surround signals.
• Surround Width: Specifies how much separation (in dB) is between the decoded surround 
signals. At 0 dB, there is complete separation between the center and surround signals, but 
each surround signal is mono. To increase the stereo effect in the left and right surround 
channels, you can increase the parameter value. This also results in some signal being 
diverted from the center channel to the surround channels.
• LFE Balance: Adjusts the low-frequency effects (subwoofer) signal from –1 (no signal sent to 
the LFE channel) to 1 (all signal sent to the LFE channel). When the slider is centered at 0, the 
signal is distributed evenly among the five channels and the LFE channel.
• Rotation: Rotates all surround signals to the left or right in a circular manner. When the slider 
is at the extreme left or right (–180 degrees or 180 degrees, respectively), the surround signal 
is rotated to the center channel and the center signal is rotated to the surround channels. At 
0 degrees (the center of the slider), there is no rotation.
• Stereo Spread: Adjusts the amount of stereo effect from the left and right channels to the 
center and surround speakers.
• Attenuate/Collapse: Adjusts the way the panning effect is implemented. At 0, the source 
signals are attenuated (meaning that the original channel signals get louder and softer 
but are not actually diverted to other channels). At 100, the source signals are collapsed 
(meaning that the original channel signals aren't changed in volume, but instead are moved 
to other channels in the panning direction).
• Center Balance: Adjusts the balance between the center and surround signals. The slider can 
be adjusted from –100 (all center signal sent to the surround channels) to 100 (all surround 
signals sent to the center channel). At 0, the signal is balanced evenly between the center 
and surround channels.
When you make adjustments to advanced parameters, the Pan Mode indicates that it has 
been edited.
Reset pan adjustments
m To reset an edited pan mode: Choose another preset from the Pan Mode pop-up menu. The Pan 
Amount slider is not affected.
m To reset adjustments to the Surround Panner only: Click the Reset button in the Surround Panner 
section of the Audio inspector.
m To reset all adjustments: Click the Reset button at the top of the Volume and Pan section of the 
Audio inspector.
You can monitor stereo and surround sound channel levels using the Audio meters.Chapter 9 Edit audio 180
Multichannel audio editing examples
Below are examples of some multichannel audio editing workflows in Final Cut Pro.
Example: Remove unwanted noise from a specific audio component
Note: To skim audio for an individual audio component, make sure both clip skimming and 
audio skimming are turned on. For more information, see Skim media on page 76.
1 Select a clip in the Timeline, and choose Clip > Expand Audio Components (or press 
Option-Control-S).
Audio components
2 Skim or play back the audio component to find the specific place where the noise occurs.
3 Drag within the component to select the range where the noise occurs.Chapter 9 Edit audio 181
4 Do one of the following:
• To disable the portion of the component where the noise occurs: Press the V key (or press the 
Delete key).
Disabling a selected range mutes all sound within the range.
Note: To unmute (enable) the range, press the V key (or press Command-Z).
• To adjust the volume within the range: Drag the horizontal control up or down.
Keyframes are automatically created along the adjustment points within the range.
5 Play back the clip to listen to your adjustments.
6 To collapse the audio components after you complete your adjustments, choose Clip > Collapse 
Audio Components (or press Option-Control-S).Chapter 9 Edit audio 182
Example: Trim audio within an audio component 
1 Select a clip in the Timeline, and choose Clip > Expand Audio Components (or press 
Option-Control-S).
Audio components
2 Position the pointer at the edge of the audio component you want to trim.
The pointer changes to the Trim tool icon .
3 Drag to trim that section.
The trimmed section is disabled (muting all sound in that section) and appears dimmed in 
the Timeline.
To undo your trim, press Command-Z.
4 Play back the clip to listen to your adjustments.
5 To collapse the audio components after you complete your adjustments, choose Clip > Collapse 
Audio Components (or press Option-Control-S).Chapter 9 Edit audio 183
Example: Make a roll edit to all audio components
1 Select a clip in the Timeline, and choose Clip > Expand Audio Components (or press 
Option-Control-S).
Audio components
2 Position the pointer at the edge of the audio portion of the clip you want to roll.
The pointer changes to the Trim tool icon .
3 Hold down the Shift key and drag to roll back the edit point for the audio portion of the clip.
The edit point is rolled to the new location, cutting the audio at the end of the clip. The video 
portion of the clip is not affected.
To undo your edit, press Command-Z.
4 Play back the clip to listen to your adjustments.
5 To collapse the audio components after you complete your adjustments, choose Clip > Collapse 
Audio Components (or press Option-Control-S).Chapter 9 Edit audio 184
Example: Add or remove audio components in a multicam clip
When you create a multicam clip that contains multiple audio components, you can use the 
Angle Viewer or the Audio inspector to add audio components from inactive angles to the active 
angle. This makes it easy to add audio from different source clips in your multicam clip while 
maintaining the active video angle. You can also remove audio components from the active 
angle to eliminate unwanted or unused audio.
Before you start, you can make adjustments to the channel configuration of audio components 
in your source clips in the Event Browser using the Audio inspector. For more information, see 
Configure audio channels on page 169.
1 Drag a multicam clip from the Event Browser to the Timeline.
2 To open the Angle Viewer, do one of the following:
• Choose Window > Viewer Display > Show Angles (or press Command-Shift-7).
• Choose Show Angles from the Viewer Options pop-up menu in the top-right corner of 
the Viewer.
The active angle appears highlighted in yellow.
Active angle 
in the Angle Viewer
3 To enable audio-only switching in the Angle Viewer, click the right switch mode button in the 
upper-left corner.
Click to enable 
audio-only switching.
4 To open the Audio inspector, do one of the following:
• Choose Window > Show Inspector (or press Command-4), and click the Audio button at the 
top of the Inspector pane.
• Click the Inspector button in the toolbar (shown below), and click the Audio button at the top 
of the Inspector pane.
The audio corresponding to the active angle in the Angle Viewer appears highlighted in the 
Channel Configuration section of the Audio inspector.Chapter 9 Edit audio 185
5 To reveal the audio components for the active angle, click the disclosure triangle next to the 
active angle’s source clip name. 
Click to reveal audio components 
for the active angle.
6 To add audio components from inactive angles, do one of the following:
• In the Angle Viewer: Hold down the Command and Option keys and click an inactive angle 
or angles.
• In the Audio inspector: Select the checkbox next to each audio component you want to add.
In this example, the angle whose audio you added is highlighted in green in the Angle Viewer, 
and the audio components you added are highlighted in the Audio inspector.
Audio components 
added to the active angle
Audio components 
added to the active angleChapter 9 Edit audio 186
The added audio components also appear in the multicam clip’s component arrangement in the 
Timeline. (To show expanded audio components, choose Clip > Expand Audio Components, or 
press Option-Control-S.)
Audio components 
added to the Timeline
7 To remove an audio component from the active angle, do one of the following:
• In the Angle Viewer: Hold down the Command and Option keys and click the angle (highlighted 
in green) whose audio you want to remove.
• In the Audio inspector: Deselect the checkbox next to the audio component you want 
to remove.
When a component is removed, it appears dimmed in the Audio inspector and the angle is 
no longer highlighted in green in the Angle Viewer. The component also disappears from the 
multicam clip’s component arrangement in the Timeline.
Use roles to organize clips and export audio files
Final Cut Pro assigns an audio role (Dialogue, Music, or Effects) to the audio portion of all clips 
on import.
Role assignments make it easy to organize clips by audio type, but their most powerful benefit 
is the ease with which you can export separate files (called media stems) from Final Cut Pro for 
all dialogue, music, or effects clips. This process is often used when delivering stems to match 
broadcast specifications or when handing off stems for mixing or post-production.
You can use roles for the following workflows:
• Reassign roles: You can view and reassign clip roles in the Timeline Index, the Event Browser, 
the Info inspector, or the Modify menu. You can also view and reassign a role for an audio 
component in the Info inspector (or by using the Modify menu when the clip that contains 
the audio component is in the Timeline). See View and reassign roles on page 300. You can 
also create custom roles and subroles to further organize your clips. 
• View and organize clips by role: In the Timeline Index, you can organize clips by role, turn roles 
on or off, and highlight or minimize clips for viewing in the Timeline. For example, you could 
easily identify all your dialogue clips and play them back in isolation from other audio clips. 
See View clips by role in the Timeline on page 305.
• Export media stems: You can export roles as media stems in a combined, multitrack QuickTime 
file, or as separate audio or video files. During the export process you can assign mono, stereo, 
or surround output for your audio channels. See Sharing projects overview on page 377.Chapter 9 Edit audio 187
Add and adjust audio effects
Add audio effects
In addition to the built-in audio enhancement features of Final Cut Pro, you can take advantage 
of 64-bitOS X built-in and third-party Audio Units (AU) effects for your audio processing tasks.
Final Cut Pro also comes with an extensive range of custom audio effects and professional Logic 
Effects, which are digital signal processing (DSP) effects and processors that are used to color or 
tonally shape existing audio recordings and audio sources—in real time.
Some of the most common processing options include noise reduction, pitch correction, 
EQs, dynamic processors, and reverbs. Further advanced features include delays, modulations, 
distortions, bass enhancement, and time-altering processors and utilities. Some custom effects 
included with Final Cut Pro combine multiple effects to create a particular sound environment, 
such as a cathedral.
You can add effects to individual clips or to a compound clip. Once you add an effect, you can 
adjust its settings using the Audio inspector.
Add audio effects to a clip
1 Click the Effects button in the toolbar.
2 In the Effects Browser, select an audio effect, and do any of the following to help you make the 
selection:
• To preview what the effect sounds like using the audio from the currently selected Timeline clip: 
Move the pointer over the audio effect thumbnails.
• To preview changing the effect’s primary control: Hold down the Option key while moving the 
pointer over an audio effect thumbnail.
• To filter the list of effects that appear: Type text in the Effects Browser search field.
3 Do one of the following:
• Drag the effect to an audio clip (or a video clip with audio) in the Timeline.
• Double-click the effect icon to apply it to the selected clip.
The effect appears in the Effects section of the Audio inspector and in the Audio Animation 
Editor. You can now adjust the effect.
Turn off a clip effect
After you apply an audio effect to a clip, you can turn off the effect (but retain its settings) in the 
Audio inspector or the Audio Animation Editor.
1 Select the clip with the effect in the Timeline.
2 Do one of the following:
• In the Effects section of the Audio inspector, select the effect and click its blue checkbox.
• In the Audio Animation Editor, select the effect and click its green checkbox.Chapter 9 Edit audio 188
Remove a clip effect
After you apply an audio effect to a clip, you can remove the effect from the clip in the Audio 
inspector or the Audio Animation Editor.
1 Select the clip with the effect in the Timeline.
2 Do one of the following:
• In the Effects section of the Audio inspector, select the effect and press Delete.
• In the Audio Animation Editor, select the effect and press Delete.
Change the order of effects
After you apply audio effects to a clip, you can change the order in which they appear in the 
Audio inspector or the Audio Animation Editor.
1 In the Timeline, select a clip for which you’ve added effects.
2 Do one of the following:
• In the Effects section of the Audio inspector, drag an effect up or down.
• In the Audio Animation Editor, drag an effect up or down.
Copy all of a clip’s effects to another clip
You can copy effects and their settings from one clip to another. This can be especially useful if 
you’ve made adjustments to effects in a clip that you want to preserve and use with other clips. 
1 Select a clip in the Timeline, and choose Edit > Copy (or press Command-C).
2 Select the clip or clips to which you want to apply the effects, and choose Edit > Paste Effects (or 
press Command-Option-V).
If a clip has more than one effect applied to it, all of the effects and their settings are applied to 
the other clip.
Copy selected clip attributes to another clip
You can copy a clip’s audio attributes, such as settings and effects, from one clip to another. 
For example, you can copy pan settings, or any effects you’ve added to a clip, including any 
keyframe adjustments.
This feature lets you select which clip attributes you want to apply.
1 Select a clip in the Timeline, and choose Edit > Copy (or press Command-C).
2 Select the clip or clips to which you want to apply the attributes, and choose Edit > Paste 
Attributes (or press Command-Shift-V).
3 Do any of the following:
• To apply all audio attributes from the source clip: Select the Audio Attributes checkbox.
• To apply individual attributes: Select the checkbox or checkboxes for each attribute you want 
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• If you made any keyframe adjustments to the source clip: Choose either Maintain Timing or 
Stretch to Fit from the Keyframes pop-up menu. If you choose Stretch to Fit, Final Cut Pro 
adjusts the keyframes in time to match the duration of the destination clip.
4 Click Paste.
For more information about using the Logic Effects that are included with Final Cut Pro, see the 
Final Cut Pro X Logic Effects Reference at http://help.apple.com/finalcutpro-logiceffects/mac.
Adjust audio effects
You can adjust an effect’s parameters using controls in the Audio inspector or the 
effect’s window.
If you’re using Audio Units effects or Logic Effects, you can show an expanded interface by 
opening the effect’s window.
For more information about using the Logic Effects that are included with Final Cut Pro, see the 
Final Cut Pro X Logic Effects Reference at http://help.apple.com/finalcutpro-logiceffects/mac.
Adjust an audio effect
1 In the Timeline, select the clip with the effect you want to adjust.
2 Locate the effect in the Effects section of the Audio inspector.
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3 To see an effect’s parameters, do one of the following:
• Click the Controls button (to the right of the effect’s name) to show a larger window with 
advanced controls.
• Click the disclosure triangle next to Parameters to show controls in the Audio inspector.
Tip: You can adjust effects over time using keyframes in the Audio inspector or in the Audio 
Animation Editor.
4 Select effect parameters and adjust their settings as needed. You can preview your adjustments 
by using the skimmer or playing the clip in the Timeline.
To return the effect’s values to their default settings, click the effect’s Reset button .
Use effect presets
Many Audio Units and Logic effects include built-in presets that are tailored for specific settings 
or environments, such as reverb presets that simulate the acoustics of a small room or a large 
cathedral. Presets make it easy to preview and apply effects quickly.
1 Locate the effect in the Effects section of the Audio inspector.
2 Choose a preset from the Preset pop-up menu.
You can preview your presets by using the skimmer or playing the clip in the Timeline.
To return the effect to its default settings, choose Default from the Preset pop-up menu.Chapter 9 Edit audio 191
Edit and save custom presets
You can edit preset parameters by adjusting the effect’s controls. If you want to keep your 
changes, you can save them as as a custom preset.
1 Locate the effect in the Effects section of the Audio inspector.
2 Choose a preset from the Preset pop-up menu.
3 To see an effect’s parameters, do one of the following:
• Click the Controls button (to the right of the effect’s name) to show a larger window with 
advanced controls.
• Click the disclosure triangle next to Parameters to show controls in the Audio inspector.
4 Select effect parameters and adjust their settings as needed. You can preview your adjustments 
by using the skimmer or playing the clip in the Timeline.
When you adjust a preset’s parameters, the Preset pop-up menu indicates that the preset has 
been edited.
Edited preset
5 To save an edited preset, choose Save Preset from the Preset pop-up menu, and type a name for 
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Saved presets appear in the Preset pop-up menu.
To return the effect to its default settings, choose Default from the Preset pop-up menu.
Delete custom presets
1 Locate the effect in the Effects section of the Audio inspector.
2 Choose Reveal User Presets in Finder from the Preset pop-up menu.
3 Select the preset or presets you want to delete in the Finder window, and drag them to the Trash.
After a custom preset has been deleted, it no longer appears in the Preset pop-up menu.
Adjust audio effects using keyframes
With Final Cut Pro, you can use keyframes to create simple changes to audio over time, such as 
fading the volume or an effect in or out in the middle of a clip.
You place keyframes at specific points in a clip to change the parameter value of an audio 
enhancement or effect at those points. For example, you can keyframe specific points for volume 
or for an effect such as reverb or distortion.
You can set keyframes to adjust a clip’s volume directly in the Timeline or in the Audio 
inspector. To see keyframes in the Timeline for all other effects, you need to display the Audio 
Animation Editor.
For information about keyframes for video clips, see Adjust video effects using keyframes on 
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Add keyframes to a clip
1 Do one of the following:
• Select the clip in the Timeline, and choose Clip > Show Audio Animation (or press Control-A).
• Control-click the clip in the Timeline, and choose Show Audio Animation from the 
shortcut menu. 
If you’re adding keyframes for volume adjustment only, go to step 4.
Each effect in the Audio Animation Editor has a separate area for adding keyframes.
Some effects have more than one parameter and allow you to add keyframes to individual 
parameters separately. They appear in the Audio Animation Editor with a triangle next to the 
effect’s name or in the Audio inspector as additional parameter controls.
2 Select the effect for which you want to add keyframes in either the Audio Animation Editor or 
the Effects section of the Audio inspector.
3 Do one of the following:
• To see expanded parameters in the Audio Animation Editor: Click the triangle to choose an 
individual parameter from the pop-up menu, or choose All to see all keyframes.
• To see expanded parameters in the Audio inspector: Click the disclosure triangle next to 
Parameters for the effect.
4 Do one of the following for each effect parameter:
• In the Audio Animation Editor (or the audio clip for volume only): Option-click (or press Option-K) 
at a point on the horizontal effect control where you want to add a keyframe.
Keyframes for volume adjustment appear as white diamonds.
Keyframe marking where a change 
in volume level occurredChapter 9 Edit audio 194
For effects with more than one parameter, keyframes for the selected parameter appear as 
white diamonds, while keyframes for other parameters appear gray.
Keyframes appear as white diamonds for all parameters when you choose All from the effect 
pop-up menu. Double diamonds indicate that you added a keyframe for more than one 
parameter at that point.
• In the Audio inspector: Position the playhead in the Timeline at the point where you want to 
add a keyframe, and click the Keyframe button (or press Option-K).
Keyframe button
Once you add a keyframe, the Keyframe button changes to yellow, indicating that the 
playhead currently sits on this keyframe.
When you move the playhead in the Timeline, arrows appear next to the Keyframe button 
in the Audio inspector to indicate which side of the playhead has keyframes. To go to the 
previous keyframe, click the left arrow or press Option-Semicolon (;). To go to the next 
keyframe, click the right arrow or press Option-Apostrophe (’).
Click an arrow to go to the 
previous or next keyframe.
5 Add keyframes as needed.
Tip: After you’ve added one keyframe, you can add another automatically by moving the 
playhead in the Timeline and then adjusting the effect parameter (or the Volume slider when 
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Add keyframes automatically across a selected area
For volume adjustments to a clip in the Timeline, you can use the Range Selection tool to add 
keyframes automatically across a selected range.
If an effect appears in the Audio Animation Editor with a disclosure button, you can use either 
the Select or Range Selection tool to add keyframes across a selected area.
1 Do one of the following:
• Select the clip in the Timeline, and choose Clip > Show Audio Animation (or press Control-A).
• Control-click the clip in the Timeline, and choose Show Audio Animation from the 
shortcut menu. 
If you’re adding keyframes for volume adjustment only, go to step 3.
2 Select an effect, and click the disclosure button to expand it in the Audio Animation Editor.
Disclosure button
3 In the Timeline, do one of the following:
• If you’re adjusting volume only: Choose Range Selection from the Tools pop-up menu in the 
toolbar (or press R).
The pointer changes to the Range Selection tool icon . 
• If you’re adjusting an effect in the Audio Animation Editor: Choose either Select or Range 
Selection from the Tools pop-up menu in the toolbar (or press A for Select, or R for 
Range Selection).Chapter 9 Edit audio 196
4 Drag across the area where you want to adjust the volume or effect.
5 Adjust the volume or effect within the range by dragging the effect’s horizontal control up 
or down.
Keyframes are automatically created along the adjustment points within the range.Chapter 9 Edit audio 197
Adjust keyframes in the Audio Animation Editor
You can move keyframes left or right in the Audio Animation Editor. If an effect appears with a 
disclosure button, you can expand the effect view and move keyframes up or down to change 
the parameter value.
1 Select a keyframe.
2 Do one of the following:
• To change its position in the Audio Animation Editor, drag a keyframe left or right.
As you drag, the timecode value appears.
• If an effect appears with a disclosure button, click the button (or double-click the effect) to 
expand the effect view.
Disclosure button
With the effect view expanded, you can drag the keyframe up or down to change the effect’s 
parameter value.
Tip: To adjust values with greater precision, hold down the Command key while dragging the 
keyframe up or down.
To add another keyframe, Option-click (or press Option-K) at a point on the effect control 
where you want to add the keyframe. To add a keyframe and change the effect’s parameter 
value at the same time, Option-click while dragging the effect control up or down.
Adjust keyframes in the Audio inspector
For many effects, you adjust the parameter value of individual keyframes using the 
Audio inspector.
1 Select a keyframe or position the playhead on a keyframe, and adjust the parameter value in the 
Audio inspector.
2 To change the value at the next keyframe, go to the next keyframe and adjust the value again.Chapter 9 Edit audio 198
Adjust all keyframes at once in the Audio Animation Editor
m Hold down the Command and Option keys, and drag either a keyframe or the effect control up 
or down.
All keyframes are adjusted by the same amount, preserving the original shape created by any 
keyframe adjustments.
Before
After 
View only one effect at a time in the Audio Animation Editor
You can collapse the Audio Animation Editor to view only one effect at a time. This can be useful 
if you have multiple effects applied to a clip and want to preserve screen space.
1 Choose Clip > Solo Animation (or press Shift-Control-V).
2 In the Audio Animation Editor, click the triangle next to the displayed effect’s name to choose an 
effect from the pop-up menu.
Note: When Solo Animation is turned on, you can’t delete effects from the Audio 
Animation Editor.
To turn off Solo Animation, choose Clip > Solo Animation (or press Shift-Control-V).
Delete keyframes
Do one of the following:
m Select a keyframe in the Audio Animation Editor, and press the Delete key.
m Navigate to a keyframe in the Audio inspector, and click the Keyframe button.
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Hide audio animation
Do one of the following:
m Select the clip in the Timeline, and choose Clip > Hide Audio Animation (or press Control-A).
m Click the close button in the upper-left corner of the Audio Animation Editor.
m Control-click the clip in the Timeline, and choose Hide Audio Animation from the shortcut menu. 
Audio tools and techniques
Enhance audio
Final Cut Pro includes several powerful tools for both analyzing and enhancing the audio portion 
of clips, including:
• Loudness: Improves the main audio signal and makes it more uniform.
• Background Noise Removal: Reduces background noise.
• Hum Removal: Reduces common electrical hum noise at either 50 or 60 Hz.
You can analyze audio and adjust loudness, background noise, and hum using the Audio 
Enhancements inspector. You can also analyze and fix audio problems when you import a clip.
The Audio Enhancements section of the Audio inspector also includes:
• Equalization: Enhances the high-end (treble), midrange, or low-end (bass) frequencies.
All enhancements are designed to correct most common audio problems automatically or with 
minor adjustments. 
Note: When you import a clip, the analyze and fix audio function only corrects severe audio 
problems. If the clip contains moderate problems, these appear in yellow next to Audio Analysis 
in the Audio Enhancements section of the Audio inspector after the clip is imported. To correct 
these, you need to automatically enhance audio in the Audio Enhancements inspector.
Analyze audio
1 Select an audio clip or video clip with audio in the Timeline.
2 To analyze the audio, do one of the following: 
• Choose Window > Go To > Audio Enhancements (or press Command-8).
• Choose Show Audio Enhancements from the Enhancements pop-up menu in the toolbar.
• In the Audio inspector, click the Audio Enhancements Inspector button next to Audio 
Analysis in the Audio Enhancements section. (The button changes color if any adjustments 
have been made.)
The Audio Enhancements inspector appears. After analysis, indicators appear next to each 
enhancement to show results:
• A red sign indicates severe problems.
• A yellow warning triangle indicates potential problems.
• A green checkmark indicates OK.
3 To close the Audio Enhancements inspector, click the back button .
You can automatically or manually change enhancement settings to correct any problems. Chapter 9 Edit audio 200
Automatically enhance audio
You can automatically enhance audio to analyze for and correct loudness, background noise, 
and hum.
1 Select an audio clip or video clip with audio in the Timeline.
2 Do one of the following: 
• Choose Modify > Auto Enhance Audio.
• Choose Auto Enhance Audio from the Enhancements pop-up menu in the toolbar.
• Click the Auto Enhance button at the bottom of the Audio Enhancements inspector.
3 To close the Audio Enhancements inspector, click the back button . 
After analysis, a green checkmark next to an enhancement indicates that the clip was analyzed 
for that enhancement. Details appear if a correction was automatically applied.
A blue checkbox appears next to each enhancement that was turned on to apply a correction. 
Deselect the checkbox to turn off an enhancement.
Apply enhancements manually
After you analyze audio, you can adjust the enhancements manually.
1 Select an audio clip or video clip with audio in the Timeline.
2 To show the Audio Enhancements inspector, do one of the following: 
• Choose Window > Go To > Audio Enhancements (or press Command-8).
• Choose Show Audio Enhancements from the Enhancements pop-up menu in the toolbar.
• In the Audio inspector, click the Audio Enhancements Inspector button next to Audio 
Analysis in the Audio Enhancements section. (After you make any adjustments, the button 
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3 To turn on an enhancement, click its icon or select its checkbox (when the enhancement is 
turned on, its checkbox is blue).
Blue checkbox
4 If necessary, do any of the following:
• To change Loudness settings: Drag the Amount and Uniformity percentage sliders. The 
Amount slider increases or decreases the overall loudness (compression) of the clip, while 
the Uniformity slider increases or decreases the dynamic range affected.
• To change the percentage of Background Noise Removal: Drag the Amount slider.
• To remove hum: Select either 50 Hz or 60 Hz for Hum Removal.
5 To close the Audio Enhancements inspector, click the back button . 
Adjust equalization
1 Select the clip in the Timeline.
2 In the Audio Enhancements section of the Audio inspector, choose an Equalization preset from 
the Equalization pop-up menu, or click the Controls button to make manual adjustments.
Controls button
Choose a preset from 
this pop-up menu.
If you want a clip to sound like another clip, you can match the audio.Chapter 9 Edit audio 202
Sync audio and video automatically
Final Cut Pro can automatically analyze and sync the audio and video clips in your project.
For example, if you select two video clips and three separate audio clips from different sources 
that were all recorded during the same take, Final Cut Pro automatically analyzes and syncs the 
clips together into a new clip in the Event Browser.
Final Cut Pro analyzes the clips for sync points such as markers you’ve added, timecode, file 
creation date, and audio content. If no sync points can be found, the clips are synced at their 
respective starting points.
Selected clips in the Event Browser
New clip containing synchronized clips
Synchronized
clip contents
Primary storyline
for the synchronized clip
Connected 
clips
Synchronize clips
1 Select the audio and video clips you want to sync in the Event Browser.
2 Choose Clip > Synchronize Clips (or press Command-Option-G).
Synced clips are labeled “Synchronized Clip” in the Event Browser. The original clips are 
not affected.
If your synchronized clip contains audio channels that aren’t being used, you can turn them off. 
See Configure audio channels on page 169.Chapter 9 Edit audio 203
Match audio equalization settings
The Match Audio function uses equalization (EQ) to let you match a selected clip’s sound to 
another clip. This is particularly useful when you have multiple audio clips recorded in different 
environments but want the clips to sound similar to each other. 
Match audio
1 Select the clip or clips you want changed in the Timeline.
2 Do one of the following:
• Choose Modify > Match Audio.
• Choose Match from the Equalization pop-up menu in the Audio Enhancements section of the 
Audio inspector.
• Choose Match Audio from the Enhancements pop-up menu in the toolbar.
3 Click to select the clip whose sound you want to match.
4 Click Apply Match.
Once you match a clip, you can make adjustments to settings in the Audio Enhancements 
section of the Audio inspector.
Remove audio matching
1 Select the clip in the Timeline.
2 In the Audio Enhancements section of the Audio inspector, choose a different equalization 
setting from the Equalization pop-up menu.
To remove all equalization, choose the Flat setting.
Preserve pitch when retiming clips
By default, Final Cut Pro preserves pitch when retiming clips so that the pitch doesn’t sound 
higher when the clip is faster or lower when the clip is slower. You can turn this feature on or off 
before or after a clip has been retimed.
Turn Preserve Pitch on or off
1 In the Timeline, select an entire clip, or a range within a clip, whose speed you plan to change.
2 Choose Preserve Pitch from the Retime pop-up menu in the toolbar.
A checkmark to the left of the command name indicates that Preserve Pitch is turned on. To turn 
it off, choose Preserve Pitch again.204
Transitions,titles, effects, and generators overview
You can easily add special effects to video, audio, and photos in your projects. Final Cut Pro 
provides several kinds of effects and controls: 
• Transitions: Add an effect between clips to control how they change from one to the next. See 
Transitions overview on page 205.
• Titles: Use to add text at any point in your project. See Titles overview on page 213.
• Effects: Use to do a wide variety of things to your video and audio clips, from subtle (add film 
grain or a color effect to the video, or a graphic equalizer to the audio) to not so subtle (add 
droplet ripples or an insect-eye view to the video, or apply an exaggerated pitch shift to the 
audio). There are two main types of effects:
• Built-in effects: Use these standard effects to resize, move, rotate, trim, skew, crop, or apply 
the Ken Burns zooming effect to a video clip. These effects are already part of each Timeline 
clip—you just need to adjust them. See Built-in effects overview on page 219.
• Clip effects: Use these effects to change your video and audio clips to either correct issues or 
create stunning new looks or sounds. See Clip effects overview on page 231.
• Generators: Add a special element like a placeholder clip, a timecode generator, or a 
countdown timer, or add colors, patterns, or animated backgrounds to your project. See 
Generators overview on page 237.
• Onscreen controls: Customize many of your effects using onscreen controls. See Onscreen 
controls overview on page 242.
• Video Animation: Vary effect settings as a clip plays. See Video animation overview on page 247.
Effects can be added to any clips in the Timeline. Once they have been added (or in the case of 
built-in effects, adjusted), you can customize the effects using controls in an inspector, onscreen 
controls in the Viewer, and controls in the Video Animation Editor and Audio Animation Editor. 
You can also try out multiple versions of an effect using auditions.
Most of the effects and generators can be opened in Motion, an Apple application designed to 
work with Final Cut Pro, where you can customize and save specialized versions of them.
Add transitions, titles, effects, 
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Add and adjusttransitions
Transitions overview
You can add cross dissolves and other transition effects between cuts to make your program 
more interesting.
Transitions replace one shot with another over a specified period of time; when one shot ends, 
another one replaces it. Three very common video transitions occur over time: fades, cross 
dissolves, and wipes.
You can add audio-only transitions to audio edits in a connected storyline. These transitions can 
be either a fade-in, fade-out, or crossfade.
Note: When a transition is added to a video clip with attached audio, a crossfade transition is 
automatically applied to the audio. If the audio is detached or expanded from the video, the 
audio is not affected by the video transition.
How transitions are created
Transitions require overlapping video from the clips on each side of the edit point. A onesecond transition requires one second of video from the end of the left clip and one second of 
video from the start of the right clip. When you apply a transition to an edit point, Final Cut Pro 
attempts to use additional video from each of the clips to create the overlap. These additional 
(unused) sections of clips are known as media handles. The following image shows a clip with 
media handles on each end and a clip with no extra video, or media handle, at its start.
Clip selected in the Event Browser
No start media handle
Start media handle End media handle
End media handle
The media handle video may not be appropriate for use in a transition. For example, if the video 
includes unusable video such as a slate, it will be visible in the project.
You can set the default duration for transitions. See Set transition defaults on page 206.Chapter 10 Add transitions,titles, effects, and generators 206
The illustration below shows how transitions are created when the clips on either side of the 
edit point have media handles. The transition is placed so that it spans the clips; one half of the 
transition overlaps each clip. Unused media from the end of each clip is added to fill out the 
transition. The total duration of your project is unchanged.
Edit with no transition
Media handle
Clip 1 Clip 2
Clip 1
Clip 2
Media handle
Edit with transition (media handles used)
If one or both of the clips do not have enough extra content (media handles) to support a 
transition of the default duration, you are given the option to overlap media in your project to 
create the transition.
Final Cut Pro uses any available media handles and then overlaps media as necessary to create 
the transition. The illustration below shows a transition created without media handles. The 
two clips are made to overlap, and the transition is placed over the overlapping region. This is 
effectively a ripple trim edit, and the total duration of your project decreases.
Edit with no transition
Clip 1 Clip 2
Clip 1
Clip 2
Edit with transition (no media handles used)
Set transition defaults
You can set the default transition that is used with the Command-T keyboard shortcut. You can 
also set the default duration for transitions.
Set the default transition
1 Click the Transitions button in the toolbar.
2 Control-click a transition, and choose Make Default from the shortcut menu.
Set the default duration
You set the default duration for transitions in Final Cut Pro preferences.
1 Choose Final Cut Pro > Preferences, or press Command-Comma (,), and click Editing.
2 Use the “Duration is x seconds” value slider to set the duration, in seconds, of all transitions you 
add to the Timeline.
You can adjust the duration of a transition after it is in the Timeline.
Note: Some transitions have a set duration and are not affected by this setting.Chapter 10 Add transitions,titles, effects, and generators 207
Add transitions to your project
There are several methods you can use to add transitions to your project. Once a transition is 
added, you can adjust its parameters. You can also modify the transition effect in Motion.
Add a cross dissolve
1 Choose the Select tool from the Tools pop-up menu in the toolbar (shown below), and click the 
edge of a clip (an edit point) in the Timeline.
One or both clip edges are highlighted.
Note: If you select a whole clip in the Timeline instead of just an edit point, transitions are added 
at each end of the selected clip.
2 Choose Edit > Add Cross Dissolve (or press Command-T).
The cross dissolve is inserted using the “Apply transitions using” setting. For more information, 
see Set transition defaults on page 206. If the video clip has attached audio, a crossfade transition 
is applied to the audio.Chapter 10 Add transitions,titles, effects, and generators 208
Add or change a transition using the Transitions Browser
1 Click the Transitions button in the toolbar.
2 Select a transition.
Move the pointer over the transition thumbnails to see an example of what the transition looks 
like. Additionally, you can type text in the search field to filter the list of transitions that appear.
3 Do one of the following:
• To apply the transition to an edit point: Drag the transition to it.
• To replace an existing transition in your project: Drag the transition to it.
Tip: Alternatively, you can select the edit point first, and double-click a transition in the 
Transitions Browser to apply it.
The transition is added to the edit using the “Apply transitions using” setting. For more 
information, see Set transition defaults on page 206. If the video clip has attached audio, a 
crossfade transition is applied to the audio.
Add an automatic audio crossfade
When a video clip has attached audio, the audio automatically has a crossfade transition applied 
when a video transition is applied. If the audio is detached or expanded from the video, the 
audio is not affected by the video transition. Follow these steps to add an audio crossfade 
between detached audio clips that are in a connected storyline.
1 Create an audio-only storyline that is connected to the primary storyline.
For information on creating storylines, see Add storylines on page 265.
2 Using the Select tool, click the edge of a clip (an edit point) in the storyline.
One or both clip edges are highlighted.
Note: If you select a whole clip in the storyline instead of just an edit point, transitions are added 
at each end of the selected clip.
3 To insert a crossfade, choose Edit > Add Cross Dissolve (or press Command-T).
The crossfade is inserted using the “Apply transitions using” setting. For more information, see 
Set transition defaults on page 206. You can configure the fade-in and fade-out settings in the 
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Copy a transition to other edit points using the Edit menu
1 Select a transition in the Timeline, and choose Edit > Copy (or press Command-C).
2 Using the Select tool, click the edge of a clip (an edit point) in the Timeline, and choose 
Edit > Paste (or press Command-V).
Note: If you copy a transition to an edit point that already has a transition, the existing transition 
is overwritten.
Copy a transition to other edit points by dragging
m Select a transition in the Timeline, press the Option key, and drag the transition to another 
edit point.
Note: If you copy a transition to an edit point that already has a transition, the existing transition 
is overwritten.
Delete transitions from your project
You can easily delete a transition, restoring the edit point to a simple cut.
Delete a transition
1 Select one or more transitions in the Timeline.
2 Press Delete.
The selected transitions are removed and their edit points are converted to simple cuts.
Important: If a transition you deleted used Full Overlap, the edit point is now at the center point 
of the transition that was removed, not at its original location before the transition was applied. 
You can use Edit > Undo to remove the transition and return the clips to their original length. For 
more information, see How transitions are created on page 205.
Adjust transitions in the Timeline
You can adjust a transition’s duration and move it in the Timeline. You can also trim either of the 
clips under the transition.
Change the transition duration
1 Select a transition in the Timeline.
2 Do one of the following:
• Choose Modify > Change Duration (or press Control-D), type the duration (it appears in the 
Dashboard in the toolbar), and press Return.
• Drag one end of the transition away from the transition’s center to make it longer or toward 
the center to shorten it.
Drag either transition edge 
to trim its duration.
The transition maintains its center point and equally trims both ends, with the number showing 
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Move the transition
Moving a transition actually rolls the edit under the transition, adding content to one underlying 
clip while removing content from the other clip. The overall duration of the project is not 
affected. Additionally, you can only move the transition as long as sufficient media handles are 
available for the clip that is being extended.
Clip 2
Media handle
Edit with transition
Media handle
Clip 1
Clip 2
Media handle
 Media handle
Clip 1
Edit with transition moved right
1 Select a transition in the Timeline.
2 Drag the transition trim icon in the upper-center area of the transition.
Drag to roll the edit 
under the transition.
The edit under the transition is rolled, with one clip being extended and the other shortened. A 
number appears showing the number of frames to the left (negative numbers) or to the right 
(positive numbers) you have rolled the transition.
You can also use the Precision Editor to roll the transition.
Trim a clip under a transition
The transition includes icons that make it easy to trim the left or right clip without affecting 
the transition.
1 Select a transition in the Timeline.
2 Drag one of the trim icons in the upper-left or upper-right area of the transition.
Drag to trim the start point 
of the clip on the right.
Drag to trim the end point 
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Dragging the trim icon in the upper left adjusts the right clip’s start point, and dragging the 
trim icon in the upper right adjusts the left clip’s end point. A number appears showing how 
many frames you have added to (negative numbers) or subtracted from (positive numbers) the 
clip’s duration. Trimming the clip doesn’t affect the transition’s duration, but it does affect the 
project’s duration.
You can also use the Precision Editor to trim the clips under the transition.
Adjust transitions in the Transition inspector and Viewer
You can adjust a transition using the controls in the Transition inspector and Viewer.
Adjust a transition using the Transition inspector and Viewer
1 If the Transition inspector is not already visible, choose Window > Show Inspector (or press 
Command-4).
2 In the Timeline, select the transition to adjust.
For this example, use the Circle transition.
The Viewer shows any onscreen adjustments you can make by dragging the handles. The 
Transition inspector shows the other parameters available for you to adjust. Additionally, 
some transitions have an image well for you to select a video frame that appears as part of 
the transition.
Drag onscreen controls 
to adjust selected 
transition settings.
In the above example, you can drag the white circle in the Viewer (an onscreen control) to 
position the circle wipe’s center and the square to set the border width (in this case, its softness). 
The Transition inspector includes a setting for the circle wipe’s aspect ratio and edge treatment 
(including the border color if you choose a hard edge).
Additionally, many transitions have parameters that you can animate using keyframes. For 
example, you could have the center of the Circle transition move as you play the clip.
For more information on adjusting audio crossfades in the Transition inspector, see Fade audio in 
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Adjust transitions with multiple images
Several transitions include areas that are filled with still images from the clips on either 
side of the transition. For example, this is the Pan Far Right transition (one of the Bulletin 
Board transitions).
This image is set by handle 
number 4 in the Timeline.
The areas are numbered and correlate to numbered points around the transition in the Timeline.
Adjust transitions with numbered points
1 Select the transition with numbered points in the Timeline.
2 Move the playhead over the transition until you see an area with the same number as one of the 
numbered handles in the Timeline. 
3 Drag the numbered handle to select the image to fill the area.
4 Continue until you have selected images for all of the areas.Chapter 10 Add transitions,titles, effects, and generators 213
Create specialized versions of transitions in Motion
Many of the transitions were created using Motion, an Apple application designed to work 
with Final Cut Pro. You can open these transitions in Motion, make modifications, and save the 
changes as a new transition file that appears in the Transitions Browser.
Important: The following steps require you to have Motion 5 installed on your computer.
Modify a transition in Motion
1 Click the Transitions button in the toolbar.
2 In the Transitions Browser, Control-click the transition you want to modify, and choose “Open a 
copy in Motion” from the shortcut menu.
Motion opens and the transition’s project appears.
3 Modify the transition project.
For more information, see Motion Help at http://help.apple.com/motion.
4 Choose File > Save As (or press Command-Shift-S), enter a name for this new transition (referred 
to as a Template in Motion), assign it to a category (or create a new category), choose a theme (if 
needed), and click Publish.
Note: If you choose File > Save, the transition is saved using the same name with “copy” 
appended to its end.
Add and adjusttitles
Titles overview
Titles play a critical role in movies, providing important bookends (such as opening titles and 
closing credits) and conveying time and dates within the movie. Titles, especially in the lower third 
of the screen, are also used in documentaries and informational videos to convey details about 
subjects or products onscreen. You can also add notes and placeholders within your project while 
you edit. Subtitles can be a critical element for movies originating in a different language.
You can create titles and credits within Final Cut Pro with title effects. Titles are synthesized clips 
(similar to generators) generated by Final Cut Pro. Title clips don’t refer to any media on your 
hard disk. When you add a title as a connected clip directly above another clip, the underlying 
clip appears as the title’s background, sparing you the need to perform any further compositing 
to create that effect.
Add titles to your project
You add titles to clips in your project using the Titles Browser. Once you have added text, you can 
modify the title’s text style.
Add a title to a project clip
1 Drag the playhead in the Timeline to the point where you want to add the title.
2 Click the Titles button in the toolbar (or press Command-5).Chapter 10 Add transitions,titles, effects, and generators 214
3 Do any of the following:
• To add a title from the Titles Browser: Double-click the title.
A title clip is added at the playhead location.
• To add a basic title: Choose Edit > Connect Title > Basic Title (or press Control-T).
A title clip named Basic Title (with no effects or animations) is added at the playhead location.
• To add a lower-third title: Choose Edit > Connect Title > Basic Lower Third (or press 
Shift-Control-T).
A lower-third title clip named Basic Lower Third (with no effects or animations) is added at the 
playhead location.
The title clip is connected to the clip in the primary storyline at the position of the playhead. 
Visually, the title is superimposed over the clip in the primary storyline at the playhead position. 
If the playhead is not over a clip, the title is superimposed over the default background.
Add a title as a clip in the primary storyline
There are two ways to add a title as a clip in the primary storyline. You can either insert a title 
clip at the edit point between two clips or replace an existing clip in the primary storyline with a 
title clip.
m To add a title between clips in the Timeline: Drag a title from the Titles Browser to the edit point 
between the clips where you want the title clip to appear.
m To replace an existing Timeline clip with a title clip: Drag a title from the Titles Browser to the clip in 
the Timeline that you want to replace, and choose Replace from the shortcut menu.
Enter text for your title
After you add a title clip to your project in the Timeline, you can type text for your title in 
the Viewer.
1 Select a title clip in the Timeline.
2 Move the playhead over the selected title clip.
3 In the Viewer, double-click the title text, and type text for your title.
Double-click the text box 
Next Text Layer button to type text for the title.
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4 To select a different text object, do one of the following:
• Click the Previous Text Layer or Next Text Layer button.
• Double-click a different text object.
5 Type new text as necessary.
6 To exit text editing, press Command-Return.
Note: The Previous Text Layer and Next Text Layer buttons also support Motion text edit markers. 
For more information, see Motion Help at http://help.apple.com/motion.
Adjust titles
You can edit text in the Viewer, and adjust a title’s text appearance using the Title and Video 
inspectors. For example, you can adjust a title’s opacity or modify the text’s font, alignment, color, 
glow, and drop shadow.
Edit title text 
1 Double-click a title clip in the Timeline.
2 Do one of the following:
• Double-click a text object in the Viewer.
• Select the text in the Text inspector.
3 Edit the text.
4 To exit text editing, press Command-Return.
Adjust a title’s position onscreen
1 Select a title clip in the Timeline.
2 Move the playhead over the selected title clip.
3 Do one of the following:
• In the Viewer, drag the text object to the new position.
• Double-click the text object and drag the position button to the new position.
Click the position button 
(the small circle) and drag 
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Adjust a title’s opacity
If you’re placing a title over an existing clip, you can adjust the title’s transparency.
1 Double-click a title clip in the Timeline.
2 Choose Window > Show Inspector (or press Command-4), and click the Video button at the top 
of the pane that appears.
Opacity slider
3 In the Compositing section, adjust the opacity settings.
4 To edit text editing, press Command-Return.
Note: You can also keyframe a title’s opacity setting.
Adjust a title’s settings
You can modify a title’s settings in the Title inspector.
1 Select a title clip in the Timeline.
2 Choose Window > Show Inspector (or press Command-4), and click the Title button at the top of 
the pane that appears.
3 Adjust the available settings as needed.
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Modify a title’s text style
You can modify the text style for a title.
1 Double-click a title clip in the Timeline.
The title appears in the Viewer, and the text in the first text object in the title clip is selected.
2 To modify another text object, select it in the Viewer.
3 Choose Window > Show Inspector (or press Command-4).
4 Adjust the available settings as needed.
5 To exit text editing, press Command-Return.
Note: You can also keyframe many of the settings in both the Title and Text inspectors.
Adjust multiple text objects in a title clip at once
You can adjust the settings of more than one text object at once.
1 Select a title clip in the Timeline.
2 Move the playhead over the selected title clip.
3 In the Viewer, do one of the following:
• Holding down the Command key, select the text objects you want to modify.
• Drag to select the text objects you want to modify.
4 Choose Window > Show Inspector (or press Command-4).
5 Adjust the available settings as needed.
Use the ruler to lay out and align paragraph text objects
Text created in Motion and some titles in the Titles Browser contain paragraph text. You can use 
a ruler and tabs to control the layout of paragraph text. For more information, see Motion Help at 
http://help.apple.com/motion.
1 Double-click a paragraph text object in the Viewer.
2 In the Viewer, click the Show Ruler button.
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A ruler appears above the paragraph text object in the Viewer. Tabs in the ruler show how 
tabbed text will be aligned in the selected text.
Left tab Center tab Decimal tab Right tab
3 Do any of the following:
• To add a tab: Click in the ruler.
• To change the type of tab added when you click in the ruler: Control-click in the ruler and choose 
a tab type from the shortcut menu.
• To move a tab: Drag it to another position on the ruler.
• To delete a tab: Drag it out of the ruler.
• To change a tab to another tab type: Control-click the tab and choose a tab type from the 
shortcut menu.
Remove titles from your project
You can remove a title from your project at any time.
Remove a title
m In the Timeline, select the title you want to remove, and press Delete.
Find and replace text in your project
If your project contains multiple instances of a particular word or phrase displayed in multiple 
title clips, such as names, company names, or job titles, you can find the specific word or phrase 
and quickly change each instance of it.
Find and replace title text
1 Choose Edit > Find and Replace Title Text.
2 In the Find and Replace Title Text window that appears, type the text you want to search for in 
the Find field.
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4 To choose where to search, do one of the following:
• To search for text in the selected title clip: Choose Selected Title from the “Search in” 
pop-up menu.
This option is useful for searching in title clips that have a lot of text, such as credits.
• To search for text across all the title clips in your project: Choose All Titles In Project from the 
“Search in” pop-up menu.
5 Do any of the following:
• To match how letters are capitalized in your search string: Select the “Match case” checkbox.
• To locate whole words rather than a group of letters within words: Select the “Whole words” 
checkbox.
• To have the search start over from the beginning of the searched item once it’s reached the end: 
Select the “Loop search” checkbox.
6 Do one of the following:
• To replace all instances of the text at once: Click the Replace All button.
• To replace this single instance of the text only: Click the Replace button.
• To replace this instance of the text and locate the next place the text appears: Click the Replace & 
Find button.
• To cycle forward and backward through each instance of the text you’re looking for: Click the 
Previous and Next buttons.
Adjust built-in effects
Built-in effects overview
Final Cut Pro includes several video effects that are part of each Timeline clip and directly 
accessible from the Viewer—all you need to do is select them and start making adjustments. You 
can use these to:
• Create a composited image from several clips
• Reposition or reframe a clip by zooming in on it
• Crop a clip to remove unwanted items, such as microphones or lighting equipment, that 
accidentally appear in the video
• Configure a Ken Burns effect to add life to your still images (and video clips as well)
You can use more than one of the built-in effects at the same time. For example, you can use 
Transform to reduce the image’s size and position, Trim to remove a portion of the video, and 
Distort to give the video a skewed look.
You can animate any of these effects so that they change as the clip plays. For example, you can 
have an image shrink and move offscreen. To configure an animation, you change settings at 
two or more points in the clip. When you play the clip, Final Cut Pro creates smooth animated 
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Resize, move, and rotate clips
The Transform built-in effect allows you to resize, move, and rotate an image. This effect is 
commonly used on a clip placed over a primary storyline clip, which becomes the background of 
the resized clip. It is also often used to zoom in on a clip, allowing you to reframe a shot if needed.
Adjust the Transform effect
Controls in the Viewer and Video inspector allow you to adjust this effect. However, some 
controls are found in only one or the other.
1 Select a clip in the Timeline.
2 To access the Transform controls, do one of the following:
• Choose Transform from the pop-up menu in the lower-left corner of the Viewer (or press 
Shift-T).
• Control-click in the Viewer and choose Transform from the shortcut menu.
3 To adjust the effect using the onscreen controls:
• Blue handles at each corner: Drag these to adjust the image’s size while maintaining its current 
aspect ratio.
• Blue handles in the middle of each side: Drag these to independently adjust the vertical and 
horizontal image size, changing the aspect ratio of the image.
Note: These controls aren’t available in the Video inspector.
• White circle in the center: Shows the rotation anchor point. Drag anywhere inside the image to 
adjust the image’s position.
• Blue handle extending from the center circle: Drag this to rotate the image.
Tip: For finer precision when rotating the image, drag the rotation handle farther away from 
the anchor point in the center.
Drag a corner handle 
to change the image’s 
size without changing 
its aspect ratio.
Drag a side’s handle 
to change the aspect 
ratio of the image.
Drag anywhere inside the 
image to set its position.
Drag this handle 
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4 Use the Transform controls in the Video inspector as follows:
• Position X and Y: Use these to move the image left and right (X) and up and down (Y).
• Rotation: Use this to rotate the image around its anchor point.
• Scale: Use this to change the image’s size.
• Anchor X and Y: Use these to move the image’s center point. This defines the point that the 
image rotates around.
Note: This control isn’t available in the onscreen controls.
5 When you are finished adjusting the effect and no longer need the onscreen controls, click Done. 
You can animate the effect and have it appear over a background. For details on working with 
built-in effects, see Work with built-in effects on page 226.
Trim clips
Trim controls allow you to independently trim each of the image edges, creating a window look. 
This effect, often used along with the Transform effect, is commonly used on a clip placed over a 
primary storyline clip, which becomes the background of the trimmed clip.
Adjust the Trim effect
1 Select a clip in the Timeline.
2 To access the Trim controls, do one of the following:
• Choose Crop from the pop-up menu in the lower-left corner of the Viewer (or press Shift-C).
• Control-click in the Viewer and choose Crop from the shortcut menu.
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4 To adjust the effect using the onscreen controls:
• Blue handles at each corner: Drag these to adjust the position of two trim window sides at the 
same time.
• Blue handles in the middle of each side: Drag these to independently adjust the position of 
each side.
• Anywhere inside the window: Drag anywhere inside the window to adjust its position.
Drag a handle in the middle of 
a side to change only one side.
Drag a corner handle to 
change two sides at once.
Drag anywhere in the image 
to position the trim window.
5 To individually adjust each edge using the Crop area of the Video inspector, use the Trim controls.
6 When you are finished adjusting the effect and no longer need the onscreen controls, click Done. 
You can animate the effect and have it appear over a background. For details on working with 
built-in effects, see Work with built-in effects on page 226.
Crop clips
The Crop effect makes it easy to remove unwanted areas of the image. It automatically expands 
the cropped image so that it fills the screen.
Adjust the Crop effect
1 Select a clip in the Timeline.
2 To access the Crop controls, do one of the following: 
• Choose Crop from the pop-up menu in the lower-left corner of the Viewer (or press Shift-C).
• Control-click in the Viewer and choose Crop from the shortcut menu.
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4 To adjust the effect using the onscreen controls:
• Blue handles at each corner: Drag these to adjust the crop of that corner. The cropped image 
always maintains the original aspect ratio.
• Anywhere inside the window: Drag anywhere inside the crop window to adjust its position.
Drag a corner handle to 
change the crop window’s 
size (but not its aspect ratio).
Drag anywhere inside 
the image to position 
the crop window.
Click Done to crop the image 
and expand it to full size.
5 To individually adjust each edge using the Crop area of the Video inspector, use the 
Crop controls.
Note: While you can use these controls to change the crop window’s aspect ratio, the final image 
still matches the original image’s aspect ratio, with additional content being cropped out so that 
the final image fits the original aspect ratio.
6 Click Done to have the crop applied and see the image zoomed to fill the screen.
You can animate the effect, creating the illusion of a pan and zoom camera move (effectively, 
a manual Ken Burns effect). For details on working with built-in effects, see Work with built-in 
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Pan and zoom clips with the Ken Burns effect
The Ken Burns effect creates a pan and zoom effect using the start and end positions you define. 
The Ken Burns effect is actually a Crop effect with two crop settings, one at the clip start and 
another at its end.
Adjust the Ken Burns effect
1 Select a clip in the Timeline.
2 To access the Ken Burns controls, do one of the following: 
• Choose Crop from the pop-up menu in the lower-left corner of the Viewer (or press Shift-C).
• Control-click in the Viewer and choose Crop from the shortcut menu.
3 Click the Ken Burns button at the bottom of the Viewer.
Two rectangles appear in the Viewer: a green one that defines the position and size for the start 
of the clip and a red one that defines the position and size for the end of the clip. An arrow is 
superimposed to show the direction the image travels when the clip is played.
Select the green Start or 
red End rectangle to adjust 
the crop size and position.
Click the Swap button 
to exchange the Start 
and End positions.
Click the Play Loop 
button to play the 
clip in a loop.
The default start and end settings result in a small zoom to the center of the image.
4 To choose the part of the image that appears at the start of the effect, drag the green handles to 
change the crop size of the image and drag the window to set its position.
5 To choose the part of the image that appears at the end of the effect, drag the red handles to 
change the crop size of the image and drag the window to set its position.
6 To have the clip with the effect play in a loop, click the Play Loop button.
7 To exchange the start and end positions, click the Swap button.
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Tip: Use the Crop effect and intermediate keyframes to create a Ken Burns-style effect that 
follows a more complicated path.
For details on working with built-in effects, see Work with built-in effects on page 226.
Skew a clip’s perspective
The Distort effect is similar to the Transform effect, except that you can drag each of the corners 
independently of the others, allowing you to create a skewed look or add a 3D perspective to 
the image.
Note: The Distort effect alters the shape of the video but does not actually move the video. To 
move the video to a different position, use the Transform effect.
Adjust the Distort effect
1 Select a clip in the Timeline.
2 To access the Distort controls, do one of the following: 
• Choose Distort from the pop-up menu in the lower-left corner of the Viewer (or press 
Command-Shift-D).
• Control-click in the Viewer and choose Distort from the shortcut menu.
3 To adjust the effect using the onscreen controls:
• Blue handles at each corner: Drag these to adjust the position of each corner, adding a 3D 
perspective to the image by making parts of it appear closer to you than other parts.
• Blue handles in the middle of each side: Drag these to adjust the position of each side. You can 
create a skewed look by dragging them in the same direction as their edge (as opposed to 
toward or away from the center).
• Anywhere inside the window: Drag anywhere inside the window to adjust its position.
Drag each corner 
to set its position.
Drag the center handles 
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4 To individually adjust each corner using the Video inspector, use the Distort controls.
5 When you are finished adjusting the effect and no longer need the onscreen controls, click Done. 
You can animate the effect and have it appear over a background. For details on working with 
built-in effects, see Work with built-in effects on page 226.
Work with built-in effects
Following are ways you can work with built-in effects.
Turn off or reset the effect
1 Select the clip with the effect in the Timeline.
2 Do one of the following:
• To turn off the effect and retain its settings: Click the blue checkbox next to the effect used 
(Transform, Crop, or Distort) in the Video inspector.
You can click the checkbox again to turn the effect back on, making it easy to compare how 
the clip looks with and without the effect.
Move the pointer to this 
area and click Show to 
see an effect’s settings.
Click a checkbox to turn 
an effect on or off.
Click an effect’s icon to show 
or hide its onscreen controls.
Click an effect’s Reset 
button to return its settings 
to their default values.
• To return all values for that effect to their default state: Click the Reset button .Chapter 10 Add transitions,titles, effects, and generators 227
• To turn off the effect in the Video Animation Editor: Open the Video Animation Editor by 
choosing Clip > Show Video Animation (or pressing Control-V), and click the checkbox next to 
the effect you want to turn off.
Click an effect’s checkbox 
to turn the effect on or off.
Animate built-in effects
Use keyframes to have the effect’s settings change as the clip plays. This applies to all built-in 
effects except the Ken Burns effect.
1 Select a clip in the Timeline.
2 Choose the effect you want to animate from the pop-up menu in the lower-left corner of 
the Viewer.
For this example, choose Transform (or press Shift-T).
3 Place the Timeline’s playhead at the start of the clip.
4 Adjust the effect’s onscreen controls to set the start position.
5 Click the Add Keyframe button in the upper part of the Viewer.
Click the Add Keyframe 
button to add the first 
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6 Move the playhead to the end of the clip.
7 Adjust the effect’s controls to set the end position.
A keyframe is automatically added. Additionally, for Transform effects, a line showing the image’s 
path appears.
Click the Left Arrow 
button to jump back 
to the first keyframe.
Click Done when you 
are finished creating 
the animation.
The red line shows the 
path of the image’s center.
8 To finish, click Done in the upper-right corner of the Viewer.
When you play the clip, the video moves smoothly between the keyframes, creating an animated 
effect. You can actually add multiple keyframes by moving the playhead to a new position and 
changing the effect’s controls. For more information on working with keyframes, see Video 
animation overview on page 247.
Adjust the Transform effect animation path
Transform animations have additional keyframe controls you can use to fine-tune the animation 
path. To show these, you first need to create a simple three-corner effect.
The Add Keyframe button 
changes to a Delete Keyframe 
button when you are positioned 
on a keyframe. The center keyframeChapter 10 Add transitions,titles, effects, and generators 229
1 Select a clip in the Timeline and put the playhead at its start.
2 Choose Transform from the pop-up menu in the lower-left corner of the Viewer (or press Shift-T), 
and drag the onscreen controls to reduce the image’s size and place it in the upper-left corner.
3 Click the Add Keyframe button.
4 Move the Timeline playhead to the middle of the clip.
5 Use the Transform onscreen controls to move the image to the upper-right corner.
A keyframe is automatically added, and a red line appears showing the animation’s path so far.
6 Move the Timeline playhead to the end of the clip.
7 Use the Transform onscreen controls to move the image to the bottom center.
A keyframe is automatically added, and the red line extends to this new point.
8 To jump between the keyframes, click the white squares along the red line.
The first and last keyframes have white arrows.
By default, the red line indicates a smooth path (indicated by how it curves).
9 To control the curve of the path, click the starting or middle keyframe and drag the 
curve handles.
Drag these handles 
on a middle keyframe to 
adjust the path’s curve.
The starting keyframe
The ending keyframe
10 Control-click a keyframe and choose an option from the shortcut menu:
• Linear: Use for direct, non-curved paths in and out of that keyframe.
• Smooth: Use for curved paths in and out of that keyframe, providing a more 
natural movement.
• Delete Point: Use to delete that keyframe.
• Lock Point: Use to prevent that keyframe from being adjusted. It changes to Unlock Point 
once set.
• Disable Point: Use to ignore that keyframe, but keep the keyframe in place in case you want 
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Composite effects over a background
Often, Transform, Trim, and Distort effects result in the image being less than full size, with 
the empty areas filled with black. You can replace the black with a background by placing the 
transformed clip over a background clip, known as compositing.
Do one of the following:
m Add a clip to the Timeline as a connected clip and then add the effect to that clip. 
This places the clip above the primary storyline clip, which automatically becomes the 
effect’s background.
A clip that’s composited 
over the primary storyline
The clip in the primary 
storyline that is the 
background
m If the clip is already in the primary storyline, drag it above the primary storyline, positioning it 
over the clip you want to be the background.
The result is a composited image.
The Transform and Trim effects 
were used to composite this 
image over the background.
For more information about working with connected clips, see Add storylines on page 265. For 
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Add and adjust clip effects
Clip effects overview
In addition to the built-in effects, Final Cut Pro includes a wide variety of video effects that 
you can apply to your project’s video clips. Many of the effects modify the look of your video, 
from adding a blur or glow to severe distortions. Some effects overlay camcorder or timecode 
graphics. There is also an effect for keying one video clip over another.
Final Cut Pro also includes a broad range of audio effects that you can apply to your project’s 
audio clips. Many of the effects modify the sound of your audio, from subtle echoes to severe 
pitch distortions.
Once you have added an effect, you can adjust its parameters. Some effects have few 
adjustments, while others provide a comprehensive set, allowing you a lot of control over how 
the effects look. Effects can even be animated, with their settings changing as the clip plays.
You can apply multiple effects to your clips, creating a stack of effects. The order that you apply 
the effects, however, can affect how the final video looks.
Additionally, many of the video effects can be opened and changed in Motion, allowing you to 
create specialized versions for use in your projects.
Add effects to your project
You add effects to clips in your project using the Effects Browser.
Add an effect to a project clip
1 Select a clip in the Timeline and click the Effects button in the toolbar.
2 In the Effects Browser, select an effect, using any of the following to help you make the selection:
• To preview what the effect looks like using the video from the currently selected Timeline clip: Move 
the pointer over the video effect thumbnails.
• To preview changing the effect’s primary control: Hold down the Option key while moving the 
pointer over a video effect thumbnail.
• To filter the list of effects that appear: Type text in the Effects Browser search field.
3 Do one of the following:
• Drag the effect to the Timeline clip to which you want to apply it.
• Double-click the effect thumbnail to apply it to the selected clip.
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Adjust effects in Final Cut Pro
Most effects have one or more parameters that you can adjust using the Video inspector or 
Audio inspector, the Viewer, or the Video Animation Editor or Audio Animation Editor. You can 
also control how the effect is applied to the clip, either gradually or constantly.
Adjust an effect in the Video inspector and Viewer
1 In the Timeline, select the clip with the effect you want to adjust.
2 Locate the effect in the Video inspector or Audio inspector.
Click to turn the 
effect on and off.
Click to reset the 
effect’s adjustments.
In the above example, there are several settings for the Censor effect. Many effects also have 
adjustments that appear in the Viewer, known as onscreen controls.
Tip: For audio effects, you can click the Controls button (to the right of the effect’s name) to 
show a custom control window.
Click to show the effect’s 
custom control window.
3 Select effect parameters and adjust their settings as needed.
To return the effect’s values to their default settings, you can click the effect’s Reset button .
Adjust an effect in the Video Animation Editor
Many effect parameters can be adjusted in the Video Animation Editor. Additionally, you can set 
these parameters to fade in and out, allowing you to gradually apply the effect’s settings.
1 Select the clip with the video effect in the Timeline.
2 Choose Clip > Show Video Animation (or press Control-V).Chapter 10 Add transitions,titles, effects, and generators 233
The effect appears as one of the animations in the Video Animation Editor above the clip. You 
can click its checkbox to turn the effect off and on. Effects that have more than one adjustable 
attribute also have a pop-up menu for you to choose the attribute to show and adjust.
Double-click 
effects with this 
icon to vertically 
expand them.
Choose a specific 
effect adjustment from 
this pop-up menu.
Click to turn the 
effect on and off.
3 To vertically expand the effect’s adjustment area, choose a specific effect adjustment from the 
pop-up menu (if present) and double-click it.
This applies only to effect adjustments that have a single value. An icon appears on the right side 
of the effect’s section if the adjustment can be expanded.
4 To have the effect’s setting fade in and out of the clip, drag the handles on either end of 
the effect.
Drag the fade handles to 
gradually apply the effect.
Drag this line 
to adjust the 
selected value.
You can also drag the horizontal line up and down to control the effect’s selected setting 
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Show the audio effects applied to a clip
1 Select the clip with the audio effect in the Timeline.
2 Choose Clip > Show Audio Animation (or press Control-A).
The audio effect appears as one of the animations in the Audio Animation Editor. You can click its 
green checkbox to turn the effect off and on.
Change clip effect order
You can apply multiple clip effects to a Timeline clip. The order that you apply them can affect 
the final output. For example, applying the Artifacts effect, which by default adds random white 
circles to the video, before the Aged Paper effect results in the white circles also being aged; 
applying it after Aged Paper results in the circles remaining white.
You can easily change the order of the clip effects in the Video inspector, Audio inspector, Video 
Animation Editor, or Audio Animation Editor.
Note: You cannot change the order of the built-in effects or color correction.
Change video and audio clip effect order using the Video or Audio inspector
1 Select a clip in the Timeline that has multiple video or audio clip effects applied, and do one of 
the following:
• To see the video effects: Open the Video inspector.
• To see the audio effects: Open the Audio inspector.
2 In the Video inspector or Audio inspector, drag the effects to change their order.
Built-in effects and color 
correction cannot be 
rearranged.
Drag clip effects to 
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Change video and audio clip effect order using the Video Animation or Audio 
Animation Editor
1 Select a clip in the Timeline that has multiple video or audio clip effects applied, and do one of 
the following:
• To see the video effects: Choose Clip > Show Video Animation (or press Control-V).
• To see the audio effects: Choose Clip > Show Audio Animation (or press Control-A).
2 In the Video Animation Editor or Audio Animation Editor, drag the effects to change their order.
Built-in effects 
and color correction 
cannot be rearranged.
Drag clip effects to 
rearrange their order.
Copy effects and attributes between clips
Final Cut Pro offers two ways to copy effects between clips. The Paste Attributes command lets 
you copy selected clip attributes to another clip and provides more control over individual 
effects, settings, and keyframes. The Paste Effects command lets you copy all of a clip’s effects to 
another clip and is the fastest way to copy effects and attributes.
Copy selected clip attributes to another clip
You can copy a clip’s attributes, such as settings and effects, from one clip to another. For 
example, you can copy video crop settings, audio pan settings, or any effects you’ve added to a 
clip, including any keyframe adjustments.
The Paste Attributes feature allows you to select which clip attributes you want to apply.
1 Select a clip in the Timeline, and choose Edit > Copy (or press Command-C).
2 Select the clip or clips to which you want to apply the attributes, and choose Edit > Paste 
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3 Do either of the following:
• To apply all video or all audio attributes from the source clip: Select the Video Attributes or Audio 
Attributes checkbox.
• To apply individual attributes: Select the checkbox or checkboxes for each attribute you want 
to apply.
4 If you made any keyframe adjustments to the source clip, choose either Maintain Timing or 
Stretch to Fit from the Keyframes pop-up menu. If you choose Stretch to Fit, Final Cut Pro adjusts 
the keyframes in time to match the duration of the destination clip.
5 Click Paste.
Copy all of a clip’s effects to another clip
1 In the Timeline, select the clip you want to copy the effects from, and choose Edit > Copy (or 
press Command-C).
2 Select the clip or clips to which you want to apply the effects, and choose Edit > Paste Effects 
(or press Command-Option-V).
All the source clip’s effects and their settings are applied to the destination clip. For more 
control over individual attributes, follow the instructions in “Copy selected clip attributes to 
another clip,” above.
Turn off or remove an effect from a clip
When you apply an effect to a clip, you can either turn off the effect (but retain its settings) or 
remove the effect from the clip.
Turn off a clip effect
1 Select the clip with the effect in the Timeline.
2 Do one of the following:
• Choose Clip > Show Video Animation (or press Control-V) to see video effects or choose Clip > 
Show Audio Animation (or press Control-A) to see audio effects, select the effect, and click 
its checkbox.
• Select the effect in the Video inspector or Audio inspector, and click its blue checkbox.
The effect no longer affects the video or audio. You can click the checkbox again to turn the 
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Remove an effect from a clip
1 Select the clip with the effect in the Timeline.
2 Do one of the following:
• Choose Clip > Show Video Animation (or press Control-V) to see video effects or choose Clip > 
Show Audio Animation to see audio effects, select the effect, and press Delete.
• Select the effect in the Video inspector or Audio inspector, and press Delete.
Create specialized versions of the video effects in Motion
Many of the supplied video effects were created using Motion, an Apple application designed 
to work with Final Cut Pro. You can open any of these effects in Motion, make modifications, and 
save the changes as a new effect that appears in the Effects Browser.
Important: The following steps require you to have Motion 5 installed on your computer.
Modify a video effect in Motion
1 Click the Effects button in the toolbar.
2 In the Effects Browser, Control-click the effect you want to modify, and choose “Open a copy in 
Motion” from the shortcut menu.
Motion opens and the effect’s project appears.
3 Modify the effect’s project.
For more information, see Motion Help at http://help.apple.com/motion.
4 Choose File > Save As (or press Command-Shift-S), enter a name for this new effect (referred to 
as a Template in Motion), assign it to a category (or create a new category), choose a theme (if 
needed), and click Publish.
Note: If you choose File > Save, the effect is saved using the same name with “copy” appended to 
its end.
Add generators
Generators overview
Final Cut Pro includes a number of video clips, called generators, that you can use in your project 
for a variety of purposes. For example, you can use generators to add the following elements:
• Placeholder content: If your project is missing content that hasn’t yet been shot or delivered, 
you can add a placeholder clip. The placeholder generator allows you to add a clip to the 
Timeline with a suitable silhouette to represent the missing content. See Use a placeholder on 
page 238.
• Timecode counter: You can add a generated timecode clip to your project to superimpose 
a timecode counter over a portion or the entire project. See Use a timecode counter on 
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• Shape clip: You can choose from a wide variety of shapes for adding graphical elements to 
your project. See Use a shape on page 239.
• General-purpose background clip: Final Cut Pro includes a variety of still and animated 
backgrounds over which you can superimpose titles or keying effects. See Use a 
background on page 240.
All of the generators are added as clips to the project, using their default duration. You can 
change their duration and position the same way you would any other video clip in the Timeline.
Note: Generator clips do not appear in the Effects Browser.
Use a placeholder
Generated placeholders are useful in many situations where you want to fill a gap in the project 
with something that provides a hint about what the final content will include. You can configure 
placeholder clips to represent a wide variety of standard shots, such as close-ups, groups, wide 
shots, and so on.
Insert and configure a placeholder clip
1 Drag the playhead in the Timeline to the point where you want to add the placeholder clip.
2 Do one of the following:
• Choose Edit > Insert Placeholder.
• Open the Generators Browser by clicking the Generators button in the toolbar, and doubleclick the thumbnail named Placeholder.
3 Select the placeholder clip in the Timeline.
4 Configure the shot for the clip to represent using the settings in the Generator inspector.
5 Select View Notes to add a text area in the Viewer where you can type text that pertains to 
this clip.
If you prefer to fill a gap in your Timeline with a blank clip, you can insert a gap clip. For more 
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Use a timecode counter
When sending your project for review, it can be useful to superimpose timecode over it, making 
it easier for the reviewer to precisely specify sections when providing feedback.
Insert and configure a timecode counter
1 Open the Generators Browser by clicking the Generators button in the toolbar.
2 Drag the Timecode generator above the primary storyline.
Usually the Timecode generator clip is placed at the start of the project, but you can place it 
anywhere you want it to appear and adjust its length to match the project’s length.
3 Configure the Timecode settings in the Generator inspector.
You can click the Reset button to return the generator to its default settings.
Use a shape
You can configure the Shapes generator to be any of a number of shapes, such as a star, a 
diamond, an arrow, and a heart. These are most often used above the primary storyline to add 
a graphical element to your project that you can animate.
Insert and configure a shape
1 Open the Generators Browser by clicking the Generators button in the toolbar.
2 Drag the Shapes generator above the primary storyline so that it is over the video clip you want 
the shape to appear over.
The default shape is a white circle.
3 Choose the shape to use from the Shape pop-up menu in the Generator inspector.
4 Set the shape’s fill color, outline color and width, and drop shadow.
You can click the Reset button to return the generator to its default settings.Chapter 10 Add transitions,titles, effects, and generators 240
5 To change the shape’s size, position, and rotation, use the Transform or Distort built-in effect.
Use the Transform effect 
to change the size, position, 
and rotation of the shape.
Using these effects also makes it possible to animate the shape. For example, you can have an 
arrow follow a person across a room.
6 To make the shape partially transparent, select it in the Timeline and adjust its Opacity setting in 
the Video inspector.
Use a background
Many of the generators provide a general background over which you can place built-in effects, 
titles, keys, and clips with an alpha channel. Some are solid colors while others are textures 
such as wood or stone. Some generators even have animated movement, providing a more 
interesting background.
Insert and configure a background clip
1 Drag the playhead in the Timeline to the point where you want to add the background clip.
2 Open the Generators Browser by clicking the Generators button in the toolbar.
3 In the Generators Browser, double-click the background thumbnail you want to use.
4 Select the background clip in the Timeline.
5 Configure the background (if applicable) using the settings in the Generator inspector.Chapter 10 Add transitions,titles, effects, and generators 241
Create specialized versions of the generators in Motion
Many of the generators were created using Motion, an Apple application designed to work 
with Final Cut Pro. To further customize the generators, you can open them in Motion, make 
modifications, and save the changes as a new file that appears in the Generators Browser.
Important: The following steps require you to have Motion 5 installed on your computer.
Modify a generator or background in Motion
1 Open the Generators Browser by clicking the Generators button in the toolbar.
2 In the Generators Browser, Control-click a thumbnail, and choose “Open a copy in Motion” from 
the shortcut menu.
Motion opens and the clip’s project appears.
3 Modify the clip’s project.
For more information, see Motion Help at http://help.apple.com/motion.
4 Choose File > Save As (or press Command-Shift-S), enter a name for this new generator, and 
click Save.
Note: If you choose File > Save, the generator is saved using the same name with “copy” 
appended to its end.
About themes
Final Cut Pro includes a number of generators, transitions, and titles, grouped into themes. The 
generators, transitions, and titles in each theme use related shapes and colors, which result in a 
visual style unique to each theme.
Theme names—such as Boxes, Comic Book, or Documentary—suggest elements used by the 
theme, or the type of project in which a theme might be used. Each theme may contain multiple 
video generators, video transitions, and titles.
To access the Themes Browser, click the Themes button in the toolbar.
For more information about video generators, see Generators overview on page 237.
For more information about video transitions, see Transitions overview on page 205.
For more information about titles, see Titles overview on page 213.Chapter 10 Add transitions,titles, effects, and generators 242
Use onscreen controls
Onscreen controls overview
Many effects, transitions, and other items use onscreen controls, superimposed over the video 
in the Viewer, to make it easier to adjust a variety of parameters. In many cases, these onscreen 
controls duplicate controls in the inspectors, although in some cases the controls are unique and 
provide the only way to adjust a particular parameter.
The controls can be as simple as defining the center of a fisheye effect or defining the more 
complex diameter, width, and position of a vignette effect.
This section focuses on the types of onscreen controls found in clip effects and transitions. 
Onscreen controls are also available in other areas of Final Cut Pro, including the following:
• Built-in effects: Onscreen controls are used extensively for all built-in effects. See Built-in effects 
overview on page 219.
• Chroma keying: You use specialized onscreen controls when configuring a chroma keyer. See 
Use chroma keys on page 334.
• Color corrections: Color corrections can contain onscreen controls used for creating color masks 
and shape masks. See Manual color correction overview on page 359.
Show or hide onscreen controls
The onscreen controls for transitions appear when a transition is selected. The onscreen 
controls for clip effects appear when an effect is selected, or when the playhead is positioned 
over a clip or title in the Timeline that has a video effect applied. You can also show or hide the 
onscreen controls.
Note: Onscreen controls are always hidden when you play clips in the Timeline.
Show or hide a transition’s onscreen controls
m To show the transition’s onscreen controls: Select the transition in the Timeline.
m To hide the transition’s onscreen controls: Deselect the transition in the Timeline.
Show or hide a clip effect’s onscreen controls
m To show the effect’s onscreen controls: Position the playhead over a clip with the effect, or select 
the clip with the effect in the Timeline, and then select the effect in either the Video Animation 
Editor or the Video inspector.
m To hide the effect’s onscreen controls: Deselect the clip with the effect in the Timeline, or deselect 
the effect in the Video Animation Editor or Video inspector.
Note: If a clip contains multiple effects that use onscreen controls, only the topmost effect’s 
onscreen controls appear when the playhead is positioned over the clip containing the effects.Chapter 10 Add transitions,titles, effects, and generators 243
Onscreen control examples
Following are a few examples of the onscreen controls you might use while working with 
clip effects and transitions. Many other clip effects and transitions use these same or similar 
controls—the examples are intended to provide general information about using the 
onscreen controls.
Keep the following in mind while going through these examples:
• These examples assume you are familiar with applying clip effects to clips in the Timeline.
• You can apply multiple clip effects to the same clip, but for the purpose of these examples, it’s 
best to either apply each clip effect to a different Timeline clip or remove the clip effect before 
applying a different one.
• These examples also assume you are familiar with adding transitions to edit points in 
the Timeline.
• Most of the effects and transitions have additional adjustments in the Video inspector or 
Transition inspector.
Example: Use onscreen controls to apply a Censor effect
1 Open the Effects Browser and drag the Censor effect to a clip in the Timeline.
2 To adjust the effect’s onscreen controls, do either of the following:
• To position the effect: Drag the center circle.
• To set the effect’s size: Drag the outer circle.
Drag this center circle to 
position the effect.
Drag this circle to 
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Example: Use onscreen controls to apply a Droplet effect
1 Open the Effects Browser and drag the Droplet effect to a clip in the Timeline.
2 To adjust the effect’s onscreen controls, do any of the following:
• To position the effect: Drag the center circle.
• To set the effect’s outer limit: Drag the outer circle.
• To set the effect’s inner limit: Drag the inner circle.
• To set the effect’s overall size: Drag any area in between the inner and outer circles. A shaded 
area appears when the pointer is in this area.
Drag this center circle 
to position the effect.
Drag any area between the 
circles (becomes shaded) 
to set the overall effect size.
Drag the inner circle to 
set the inner boundary.
Drag the outer circle to 
set the outer boundary.
Example: Use onscreen controls to apply a Prism effect
1 Open the Effects Browser and drag the Prism effect to a clip in the Timeline.
2 To adjust the direction of the effect, drag the arrow. 
Because the effect has no center setting, the circle in the center cannot be dragged.
Drag the arrow to set 
the effect’s direction.
This center circle cannot 
be dragged since the effect 
has no center setting.Chapter 10 Add transitions,titles, effects, and generators 245
Example: Use onscreen controls to apply a Scrape effect
1 Open the Effects Browser and drag the Scrape effect to a clip in the Timeline.
2 To adjust the effect’s onscreen controls, do either of the following:
• To position the effect: Drag the center circle.
• To set the effect’s direction: Drag the rotation handle.
Drag this handle to rotate 
the effect’s direction.
Drag the center circle to set 
the effect’s start position.
Example: Use onscreen controls to apply a Center transition
1 Open the Transitions Browser and drag the Center transition to an edit point in the Timeline.
2 To adjust the transition’s onscreen controls, do any of the following:
• To position the transition: Drag the center circle.
• To set the transition’s direction: Drag the arrow.
• To set the transition’s border width (softness in this case): Drag the outer handle toward or away 
from the center circle.
Drag this arrow to set the 
transition’s direction.
Drag this center circle to 
position the transition.
Drag this handle to set 
the border width (softness 
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Example: Use onscreen controls to apply a Star transition
1 Open the Transitions Browser and drag the Star transition to an edit point in the Timeline.
2 To adjust the transition’s onscreen controls, do any of the following:
• To position the transition: Drag the center circle.
• To set the number of points on the star: Drag the longer handle.
• To rotate the star: Drag the shorter handle.
Drag this center circle to set 
the transition’s position.
Drag this handle to set the 
number of points on the star.
Drag this handle to rotate 
the star transition.
Example: Use onscreen controls to apply a Zoom & Pan transition
1 Open the Transitions Browser and drag the Zoom & Pan transition to an edit point in 
the Timeline.
2 To adjust the transition’s onscreen controls, do either of the following:
• To set the transition’s start point: Drag the green circle.
• To set the transition’s end point: Drag the red circle.
Drag the red circle 
to set the end point.
Drag the green circle 
to set the start point.Chapter 10 Add transitions,titles, effects, and generators 247
Use the Video Animation Editor
Video animation overview
With Final Cut Pro, you can create simple changes to video over time, such as fading the video 
from invisible to visible at the beginning of a movie. Or you can make sophisticated and precise 
adjustments over time to many individual parameters of video effects, transitions, motion paths, 
and so on.
In Final Cut Pro, you use keyframes and fade handles in the Video Animation Editor to change 
effects over time.
The word keyframe comes from the traditional workflow in the animation industry, where only 
important (key) frames of an animated sequence were drawn to sketch a character’s motion over 
time. Once the keyframes were determined, an in-between artist drew all the frames between 
the keyframes.
With Final Cut Pro, you can set parameters to specific values at specific times (represented by 
keyframes) and Final Cut Pro acts as an automatic, real-time in-between artist, calculating all 
the values between your keyframes. For example, to animate a parameter, such as a rotation or 
scale setting, you need to create at least two keyframes in the clip. Final Cut Pro figures out the 
setting’s value between the keyframes, creating a smooth motion as the setting changes.
You can keyframe and animate both video and audio effects in Final Cut Pro, including individual 
effect parameters and clip properties. To learn more about keyframing audio, see Adjust audio 
effects using keyframes on page 192.
Adjust video effects using keyframes
You place keyframes at specific points in a clip to change parameter values at those points. 
For example, if you want a clip in your project to fade to black, you set two opacity keyframes at 
two different times: one with the value of 100 (fully visible) and a second with the value of 0 (fully 
transparent). Final Cut Pro interpolates the values between 100 and 0, creating a smooth fade 
to black.
You can set keyframes in the Timeline or in the Video inspector. To see keyframes in the Timeline, 
you need to display the Video Animation Editor for the clip.
Additional keyframing controls appear with the Final Cut Pro built-in effects. See Work with 
built-in effects on page 226.
For information about keyframes for audio clips, see Adjust audio effects using keyframes on 
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Add keyframes
1 Do one of the following:
• Select a clip in the Timeline, and choose Clip > Show Video Animation (or press Control-V).
• Control-click a clip in the Timeline, and choose Show Video Animation from the shortcut menu. 
Each effect in the Video Animation Editor has a separate area for adding keyframes.
Some effects have more than one parameter and allow you to add keyframes to individual 
parameters separately. They appear in the Video Animation Editor with a triangle next to the 
effect’s name or in the Video inspector as additional parameter controls.
2 Select the effect for which you want to add keyframes in either the Video Animation Editor or the 
Effects section of the Video inspector.
3 Do one of the following:
• To see expanded parameters in the Video Animation Editor: Click the triangle to choose 
an individual parameter from the pop-up menu, or choose All to add keyframes for 
all parameters.
• To see expanded parameters in the Video inspector: Click Show when you position the pointer 
over the effect.
4 Do one of the following for each effect:
• In the Video Animation Editor: Option-click (or press Option-K) at a point on the horizontal effect 
control where you want to add the keyframe.
Keyframes for the parameter you chose appear as white diamonds, while keyframes for other 
effect parameters appear gray.
Keyframe for the 
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When you choose to view all parameters in the Video Animation Editor, keyframes appear as 
white diamonds for all parameters. Double diamonds indicate you added a keyframe for more 
than one parameter at that point.
Double diamonds
• In the Video inspector: Position the playhead in the Timeline at the point where you want to 
add a keyframe, and click the Keyframe button (or press Option-K).
Once you add a keyframe, the Keyframe button changes to yellow, indicating that the 
playhead currently sits on this keyframe.
Keyframe button
When you move the playhead in the Timeline, arrows appear next to the Keyframe button 
in the Video inspector to indicate which side of the playhead has keyframes. To go to the 
previous keyframe, click the left arrow or press Option-Semicolon (;). To go to the next 
keyframe, click the right arrow or press Option-Apostrophe (’).
Arrows
5 Add keyframes as needed.
Tip: After you’ve added one keyframe, you can add another automatically by moving the 
playhead in the Timeline and then adjusting the effect parameter value in the Video inspector.
Add keyframes automatically across a selected area
If an effect appears in the Video Animation Editor with a disclosure button, you can use either 
the Select or Range Selection tool to add keyframes automatically across a selected area.
1 Do one of the following:
• Select a clip in the Timeline, and choose Clip > Show Video Animation (or press Control-V).
• Control-click a clip, and choose Show Video Animation from the shortcut menu. 
2 Select an effect, and click the disclosure button to expand it in the Video Animation Editor.
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3 In the Timeline, choose either Select or Range Selection from the Tools pop-up menu in the 
toolbar (or press A for Select, or R for Range Selection).
4 Drag across the area in the Video Animation Editor where you want to adjust the effect.
5 Adjust the effect within the range by dragging the effect’s horizontal control up or down.
Keyframes are automatically created along the adjustment points within the range.Chapter 10 Add transitions,titles, effects, and generators 251
Adjust keyframes in the Video Animation Editor
You can move keyframes left or right in the Video Animation Editor. If an effect appears with a 
disclosure button, you can expand the effect view and move keyframes up or down to change 
the parameter value.
1 Select a keyframe.
2 Do one of the following:
• To change its position in the Video Animation Editor, drag a keyframe left or right.
As you drag, the timecode value appears.
Drag the keyframe 
left or right.
• If an effect appears with a disclosure button, click the button (or double-click the effect) to 
expand it.
Disclosure button
With the effect expanded, you can drag the keyframe up or down to change the effect’s 
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Tip: To adjust values with greater precision, hold down the Command key while dragging the 
keyframe up or down.
Drag the keyframe up or down.
To add another keyframe, Option-click (or press Option-K) at a point on the effect control 
where you want to add the keyframe. To add a keyframe and change the effect’s parameter 
value at the same time, Option-click while dragging the effect control up or down.
If an effect appears with a disclosure button in the Video Animation Editor, you can also fade 
video effects in or out, or change the shape of the effect curve between keyframes.
Adjust keyframes in the Video inspector
For many effects, you adjust the parameter value of individual keyframes using the 
Video inspector.
When you move the playhead in the Timeline, arrows appear next to the Keyframe button in 
the Video inspector to indicate which side of the playhead has keyframes. To go to the previous 
keyframe, click the left arrow or press Option-Semicolon (;). To go to the next keyframe, click the 
right arrow or press Option-Apostrophe (’).
Arrows
1 Select a keyframe or position the playhead on a keyframe, and adjust the parameter value in the 
Video inspector.
2 To change the value at the next keyframe, go to the next keyframe and adjust the value again.Chapter 10 Add transitions,titles, effects, and generators 253
View only one effect at a time in the Video Animation Editor
You can collapse the Video Animation Editor to view only one effect at a time. This can be useful 
if you have multiple effects applied to a clip and want to preserve screen space.
1 Choose Clip > Solo Animation (or press Shift-Control-V).
2 In the Video Animation Editor, click the triangle next to the displayed effect’s name to choose an 
effect from the pop-up menu.
Note: When Solo Animation is turned on, you can’t delete effects from the Video 
Animation Editor.
To turn off Solo Animation, choose Clip > Solo Animation (or press Shift-Control-V).
Delete keyframes
Do one of the following:
m Select a keyframe in the Video Animation Editor, and press the Delete key.
m Navigate to a keyframe in the Video inspector, and click the Keyframe button.
After navigating to 
a keyframe, click the 
Keyframe button to 
delete the keyframe.
Hide video animation for a clip
Do one of the following:
m Select the clip in the Timeline, and choose Clip > Hide Video Animation (or press Control-V).
m Click the close button in the upper-left corner of the Video Animation Editor.
m Control-click the clip in the Timeline, and choose Hide Video Animation from the shortcut menu.
Adjust effect curves using fade handles or keyframe animation
Some effects in the Video Animation Editor include fade handles, which allow you to adjust how 
long it takes for an effect to fade in or out. For example, you can use fade handles to adjust how 
long it takes for an opacity effect to fade in, how long it takes to fade up from black, or how long 
it takes to fade to black.
You can also move keyframes up or down to create a curve for the effect parameter and change 
the curve shape (interpolation) between keyframes.
Creating a fade or an effect curve smooths the transition so that the effect changes appear more 
natural when the clip plays.
Change an effect using fade handles
1 Click the disclosure button to expand the effect in the Video Animation Editor.
Disclosure button
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2 Drag the fade handle to the point in the clip where you want the fade to begin or end.
Fade handles from the beginning of a clip create a fade-in, while fade handles at the end of a clip 
create a fade-out.
Fade-in Fade-out
Change an effect using keyframes 
m Click the disclosure button to expand the effect in the Video Animation Editor, and do either of 
the following:
Disclosure button
Note: If an effect doesn’t have a disclosure button, you can’t move keyframes up or down.
• To add a keyframe: Option-click (or press Option-K) at a point on the effect control where you 
want to add the keyframe.
Tip: To add a keyframe and change the effect’s parameter value at the same time, Option-click 
while dragging the effect control up or down.
• To change the effect’s parameter value at a particular keyframe: Select a keyframe and drag it up 
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Tip: To adjust values with greater precision, hold down the Command key while dragging the 
keyframe up or down.
Drag the keyframe up or down.
Change the curve shape (interpolation) between keyframes
Do one of the following:
m Drag the line horizontally between the keyframes to create a curve.
To adjust the curve with greater precision, hold down the Command key while dragging.
m Control-click the line between keyframes, and choose a curve option from the shortcut menu.
• Linear: Maintains a constant rate of change over the duration of the fade.
• Ease: Eases in and out of the fade with the midpoint set between the beginning and 
end values.
• Ease In: Starts slowly from the beginning value and then moves quickly toward the end value.
• Ease Out: Starts quickly from the beginning value and then slowly tapers off toward the 
end value.
Note: You can change the curve shape between keyframes for video effects only. For audio 
volume only, you can change the curve shape for fades created using fade handles, but not 
keyframes. See Fade audio in or out on page 174.Chapter 10 Add transitions,titles, effects, and generators 256
Adjust all keyframes on a curve
m Hold down the Command and Option keys, and drag either a keyframe or the curve up or down.
All keyframes are adjusted by the same amount, preserving the original shape of the curve.
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Group clips with compound clips
Compound clips overview
With Final Cut Pro, you can create compound clips, which allow you to group any combination of 
clips in the Timeline or the Event Browser and nest clips within other clips. 
Compound clips can contain video and audio clip components, clips, and other compound clips. 
Effectively, each compound clip can be considered a mini project, with its own distinct project 
properties. Compound clips function just like other clips: you can add them to your project, trim 
them, retime them, and add effects and transitions. Icons appear on compound clips in the Event 
Browser and the Timeline. 
Compound clip 
icon for a clip in 
the Event Browser
Compound clip 
icon for a clip 
in the Timeline
Compound clips have many uses. You can:
• Simplify a complicated project by creating a separate compound clip for each major section.
• Synchronize a video clip with one or more audio clips and then combine the clips into a 
compound clip, to avoid inadvertently moving them out of sync.
• Open any clip, edit its contents in the Timeline, and then close it. 
• Quickly create a compound clip containing the clips in an event, based on the Event Browser 
sort order.
• Use a compound clip to create a section of a project with settings different from those of the 
main project.
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The following diagram shows how a project in the Timeline could be simplified using 
compound clips:
Selected clips in the Timeline 
New compound clip
Compound clips have the following characteristics:
• You create compound clips in the Event Browser or in the Timeline. 
• Every compound clip in the Timeline has a “parent” compound clip in the Event Browser.
Event clips
Project 1 Project 3
Child clip Child clips Child clip
Project 2
Parent compound clip
• When you edit the contents of any compound clip, you are in fact editing the parent 
compound clip from the Event Browser. Any changes you make to the compound clip are 
inherited by all of its child clips. For example, if you delete a title clip from the contents of a 
parent compound clip, the title clip is deleted from all child clips.
You can create an independent compound clip from an existing compound clip. For example, 
you might have a compound clip of a standard title sequence for your TV or podcast series. 
You can create unique (independent) instances of the compound clip for each episode 
without affecting other instances of the title sequence. 
Note: Compound clips in Final Cut Pro X provide all the functionality of the nested sequence 
feature in Final Cut Pro 7, with more flexibility and ease of use.Chapter 11 Advanced editing 259
Create and break apart compound clips
You can create a compound clip from existing clips in the Timeline or the Event Browser, or you 
can create a new, empty compound clip in the Event Browser and add clips to it in the Timeline. 
You can also break a compound clip into its component parts in the Timeline, so that the items 
are no longer grouped.
Create a compound clip from existing clips
1 Select one or more clips in the Timeline or the Event Browser.
The selected clips can be any combination of contiguous or noncontiguous clips, compound 
clips, primary storyline clips, or connected clips.
2 Do one of the following:
• Choose File > New Compound Clip (or press Option-G).
• Control-click the selection and choose New Compound Clip from the shortcut menu.
Note: When you add a compound clip to the Timeline or create a compound clip from existing 
clips in the Timeline, you create a direct and active relationship between a parent compound clip 
in the Event Browser and the child compound clip in the Timeline. If the parent clip doesn't 
already exist in the Event Browser, Final Cut Pro creates one automatically. When you edit the 
contents of a compound clip (for example, by trimming or adding effects to clips within the 
compound clip) you are in fact editing all instances of that compound clip, including the parent 
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The way clips are grouped within the compound clip depends on where you selected the clips:
• If you selected clips in an event: Final Cut Pro creates a new compound clip in the event 
(in addition to the selected clips) and places duplicates of the selected clips in the 
new compound clip horizontally, in the order in which you selected them. (For further 
instructions on creating a compound clip in the Event Browser, see “Create an empty 
compound clip,” below.)
Selected clips in the Event Browser
New compound clip
Compound 
clip contentsChapter 11 Advanced editing 261
• If you selected clips in the Timeline: Final Cut Pro places the selected clips in the new compound 
clip exactly as they are laid out in the Timeline. The new compound clip inherits the frame size 
and frame rate of the current Timeline.
Selected clips in the Timeline 
New compound clip
Compound 
clip contents
Create an independent compound clip from an existing compound clip
1 Select a compound clip in the Timeline.
2 Choose Clip > Reference New Parent Clip.
Final Cut Pro creates a new parent compound clip in the Event Browser. This command breaks 
the relationship between the selected compound clip in the Timeline and its original parent 
compound clip (as well as any child clips of the original parent clip, in all projects). 
Note: You can also select multiple clips in step 1 and Final Cut Pro will make one or more parent 
clips, depending on the existing parent clip references.Chapter 11 Advanced editing 262
Create an empty compound clip
You can create new, empty compound clips and then add clips to them. Each compound clip can 
be considered a mini project, with its own distinct project properties.
1 In the Event Library, select an event to which you want to add the compound clip.
2 Choose File > New Compound Clip.
In the window that appears, type a name for the compound clip in the Name field.
3 Click Use Custom Settings to further customize settings for your compound clip.
Note: Final Cut Pro shows the Automatic Settings by default, but it will remember the settings 
you used last, so this step may be unnecessary.
4 By default, Final Cut Pro sets the Starting Timecode field to the lowest timecode value in the 
selected clips. If you want the compound clip’s timecode to start at a different value, type that 
starting timecode value in the Starting Timecode field.
5 To adjust video, audio, and render settings, click Custom. Unless you have a specific requirement 
for the compound clip you’re creating, it’s best to leave “Set automatically based on first video 
clip” and “Use default settings” selected.
6 Click OK.
The new compound clip appears in the event.
Edit the contents of a standard clip in the Timeline
You can edit the contents of a standard clip.
m Select a clip in the Event Browser or the Timeline, and choose Clip > Open in Timeline.
The Timeline displays the contents of the clip. Most standard clips include a video component, an 
audio component, or both. You cannot edit the contents of these video and audio components.
You can add media to the contents of this clip (by adding clips to this Timeline). To close this clip, 
navigate up one level in the Timeline history.
Note: Because editing in Final Cut Pro is nondestructive, any changes you make to the contents 
of standard or compound clips do not affect the corresponding source media files, which remain 
unchanged on your computer’s hard disk. For more information about the difference between 
media files and clips, see Media files and clips on page 17.
Break apart clip items
You can break apart a compound clip or a standard clip to convert its contents to individual clips 
in the Timeline.
m Select a compound clip or a standard clip in the Timeline, and choose Clip > Break Apart Clip 
Items (or press Command-Shift-G).
Final Cut Pro replaces the clip selected in the Timeline with the individual items that made up 
the clip.
If you selected a compound clip, its contents revert back to the original clips that made up the 
compound clip. However, the parent compound clip remains in the Event Browser.
If the selected clip is a standard clip, the contents appear as individual clips in the Timeline. Most 
standard clips include a video component or an audio component or both. The audio will appear 
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Manage compound clips
There are many ways to manage and edit compound clips. For example, you can open up 
compound clips (and edit their component parts) in a separate Timeline. You can easily navigate 
up and down a series of compound clip levels. And you can open and edit a compound clip from 
within an event.
Note: When you edit the contents of a compound clip (for example, by trimming or adding 
effects to clips within the compound clip) you are in fact editing all instances of that compound 
clip, including the parent compound clip in the Event Browser. Any changes you make to the 
internal parts of the compound clip are inherited by all of its child clips, in all projects. These 
changes can include added or deleted clips, trimming adjustments, and video or audio effects 
such as color correction, clip speed retiming, and so on. For example, if you delete a title clip 
from a parent compound clip, the title clip is deleted from all child compound clips.
Open a compound clip for editing
Do one of the following:
m Select a compound clip in the Timeline or the Event Browser, and choose Clip > Open 
in Timeline.
m Double-click the video portion of a compound clip in the Timeline or the Event Browser.
m Click the compound clip icon in the upper-left corner of a compound clip in the Timeline.
The compound clip opens in a new Timeline view, with its contents ready for editing.
Compound clip in a project in the Timeline
Compound clip opened in a new Timeline view
Project Compound clip
Project
Note: Because editing in Final Cut Pro is nondestructive, any changes you make to the contents 
of standard or compound clips do not affect the corresponding source media files, which remain 
unchanged on your computer’s hard disk. For more information about the difference between 
media files and clips, see Media files and clips on page 17.Chapter 11 Advanced editing 264
Navigate compound clip levels using menu commands and keyboard shortcuts
You can navigate up or down one or more levels of a compound clip.
m To move forward (down one level): Choose View > Timeline History Forward, or press 
Command–Right Bracket (]).
m To move back (up one level): Choose View > Timeline History Back, or press Command–Left 
Bracket ([).
Navigate compound clip levels using the arrow buttons
Do one of the following:
m Click the left and right arrows in the upper-left corner of the Timeline.
m Click and hold the right or left arrow in the upper-left corner of the Timeline, and choose a level 
from the pop-up menu.
The left arrow effectively closes the current compound clip and opens its parent, with the top 
level being the project or event containing the compound clip. If there is no history available to 
navigate, both the left and right arrows are dimmed. 
Make sure all contents of a compound clip appear in your movie
When you’re editing the contents of a compound clip, Final Cut Pro indicates the boundary of 
the compound clip with a dark gray, cross-hatched area to the left of the start point of the clip 
and to the right of the end point of the clip.
If you add clips to the contents of the compound clip, any parts of any clips that extend into the 
dark gray area do not appear in your project.
Any clips in the dark gray, 
cross-hatched area do not 
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To have the new clip material appear in your project, do one of the following to make room for 
the new material:
m Reduce the total duration of the other clips inside the compound clip. For example, you could 
trim one or more clips inside the compound clip.
m Close the compound clip to navigate up one level, and extend the total duration of the parent 
clip (the “outside shell” of the compound clip) in the Timeline.
For more information, see Trimming overview on page 123.
Add storylines
Storylines are sequences of clips connected to the primary storyline. They combine the 
convenience of connected clips with the precision editing capabilities of the primary storyline.
You can use storylines for the same purposes as connected clips (such as creating cutaways, 
compositing titles and other graphics, and adding sound effects and music). 
The unique advantage of storylines is the ability to edit a sequence of connected clips within the 
context of the other clips in the Timeline. For example, you can add cross dissolve transitions to a 
series of superimposed titles in a storyline and then adjust the timing of the titles to match clips 
in the primary storyline. Like connected clips, storylines can contain both video and audio, or 
they can be video only or audio only. For more information about connected clips, see Connect 
clips to add cutaway shots, titles, and synchronized sound effects on page 103.
Storyline
Primary storyline Audio-only storylineChapter 11 Advanced editing 266
You edit storylines using the same methods you use to edit the primary storyline. You can: 
• Add clips: Drag clips to the storyline to add them, or use the standard append, insert, replace, 
and overwrite commands.
• Add transitions, titles, effects, and generators: Add effects to a storyline by dragging them or by 
using any of the standard commands and keyboard shortcuts.
Note: When you apply a transition to a clip connected to the primary storyline, a storyline is 
automatically created for that clip.
• Trim clips: Use any of the standard trim edits in a storyline, including ripple, roll, slip, and slide. 
You can also trim or move clips within storylines by entering timecode values.
• Create split edits: Set separate video and audio start and end points in an individual clip to 
create split edits (L-cuts and J-cuts) in a storyline.
Create or break apart storylines
You can quickly create storylines from existing connected clips.
1 In the Timeline, select two or more connected clips.
2 Choose Clip > Create Storyline (or press Command-G).
A gray border appears around the clips, indicating a storyline.
The gray border 
indicates a storyline.
Note: If the original connected clips are not contiguous, Final Cut Pro inserts a gap clip to fill the 
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You can also create a storyline by holding down the G key as you drag a clip to a connected clip 
so that their edges touch:
Hold down the G key as you 
drag a clip to a connected clip.
3 To convert a storyline back to its component clips, do one of the following:
• Select the storyline (by clicking the gray border), and choose Clip > Break Apart Clip Items (or 
press Command-Shift-G). 
• Drag the storyline into the primary storyline.
Select and move storylines
You can select or move entire storylines as if they were standard clips or compound clips. They 
have the connection properties of connected clips.
m To select an entire storyline: Click the gray border of the storyline.
m To move a storyline by dragging it: Click the gray border of the storyline, and drag it left or right to 
connect it to a different point along the primary storyline.
Drag the storyline left or right.
m To move a storyline with timecode values or keyboard shortcuts: Use the same techniques you 
would use with standard clips.
For more information, see Arrange clips in the Timeline on page 117.Chapter 11 Advanced editing 268
Fine-tune edits with the Precision Editor
You can fine-tune the edit point between two clips in the Timeline using the Precision Editor, 
which provides an expanded view of the clips on either side of the edit point as well as the 
unused portions of each clip. You can trim or extend the end of one clip and the beginning of 
the next, either separately or together. As you make changes, you can instantly see how your 
edits affect the cut or transition from one clip to the next.
You can see a “two-up” display in the Viewer as you trim edit points in the Timeline. For more 
information, see Show detailed trimming feedback on page 138.
Adjust the edit point between clips with the Precision Editor
1 Choose either the Select tool or the Trim tool from the Tools pop-up menu in the toolbar, 
and double-click the edit point you want to trim in the Timeline.
Double-click the edit point 
you want to trim.
The Precision Editor appears, presenting an expanded view of your outgoing and incoming 
shots. The edit point is represented by a vertical line in the center of the Precision Editor. The 
outgoing clip and the clips before it appear in the top part of the storyline. The incoming clip 
and the clips after it appear in the bottom part.
The dimmed portions of clips to the right and left of the edit line are the unused portions of 
media that are available for trimming (called media handles). You can skim over these areas to 
view and play back the media to help you decide where to trim.
Outgoing clip end point Edit line Skimmer
Edit line handle Incoming clip start pointChapter 11 Advanced editing 269
2 To adjust the edit point, do any of the following:
• Move the edit line in the center of the Precision Editor by dragging its handle left or right.
Drag the edit line 
handle left or right.
Moving the entire edit line performs a roll edit.
• Drag the end point of the outgoing clip or the start point of the incoming clip. This performs a 
ripple edit.
Note: You can drag the edit line or individual edit points to the extent that there are media 
handles available. When you extend a clip to its maximum length in either direction, the clip 
edge turns red.
Drag the end point of the 
outgoing clip or the start 
point of the incoming clip.Chapter 11 Advanced editing 270
• Skim over and click the outgoing clip or the incoming clip at any point. 
Click either clip at any point.
The clip’s edit point is adjusted to the frame you click. This is the equivalent of a ripple edit.
The clip’s edit point moves 
to the frame you click.
You can also enter a timecode value to adjust the edit point numerically. If you select either 
the end point of the outgoing clip or the start point of the incoming clip, a ripple edit is 
performed. Otherwise, a roll edit is performed.
3 To navigate to another edit point, do one of the following:
• To go directly to an edit point: Click the other edit point.
• To go to the next or previous edit point: Press the Up Arrow or Down Arrow key.
4 To close the Precision Editor, do one of the following:
• Double-click the current edit point, or press the Esc (Escape) key.
• Click the Close Precision Editor button at the bottom-right corner of the Timeline.Chapter 11 Advanced editing 271
Create split edits
Final Cut Pro allows you to set separate video and audio start and end points in an individual 
clip. These edits, known as split edits, can be used in many different situations—in dialogue 
scenes, when cutting to illustrative B-roll footage during an interview, or when transitioning from 
one scene to another.
 You can use a split edit to introduce the sound of a new shot or scene before cutting to the 
video of that shot or scene. Conversely, you can use a split edit to extend the audio of a shot 
over a subsequent shot. For example, you could cut from a clip of a person talking to video of a 
person listening, while the audio from the first clip continues.
The split edit technique results in L-shaped and J-shaped clips with audio extending to the left 
or the right. These are known as L-cuts and J-cuts.
Note: Whenever you use split edits in a project, it’s recommended that you choose View > 
Expand Audio/Video Clips > For Splits (so that there’s a checkmark next to the menu item). This 
setting provides you with the most accurate display of all your split edits. 
Create a split edit by dragging
To create the split edit, you extend the audio of one clip over a neighboring clip. In this example, 
the audio from the close-up of the man is extended over the close-up of the woman to create 
a J-cut.
1 Add clips to the Timeline in the order in which you want them to appear in your movie.
2 To show separate audio for the clip you want to edit, do one of the following:
• In the Timeline, select the clip whose audio you want to expand, and choose Clip > Expand 
Audio/Video (or press Control-S).
• Double-click the clip’s audio waveform.
The audio and video portions of the clip appear as discrete components that you can change 
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3 Drag the start point (left edge) of the video portion of the clip to the right, effectively trimming it 
with a ripple edit. 
The example below shows the video start point of the close-up of the man being dragged to 
the right.
This creates a J-shaped split edit, with the start point of the audio overlapping the 
preceding clip.
4 To complete the split edit, show separate audio for the preceding clip, and do one of 
the following:
• Drag the preceding clip’s end point to the left so that the two audio clips no longer overlap.
• Adjust the audio (fade) level of either clip so that the audio overlap sounds natural. Chapter 11 Advanced editing 273
5 If you want to turn off the separate audio view to “clean up” the affected clips, do one of 
the following:
• Choose View > Collapse All Clips.
• Select the clip in the Timeline, and choose Clip > Collapse Audio/Video (or press Control-S).
• Double-click the clip’s audio waveform.
When you play back this section of the Timeline, you hear the man begin to speak before the 
video cuts to the close-up of him. In this way, you can use split edits to create seamless edits 
from one shot to the next.
Create a split edit using keyboard shortcuts
You can create split edits quickly using keyboard shortcuts. In this example, the audio from the 
close-up of the man is extended over the close-up of the woman to create a J-cut.
1 Confirm that the two adjacent clips have sufficient media handles. If not, trim the clips (shorter) 
to create the media handles.
2 To expand (show separate audio) for the two adjacent clips, do one of the following:
• In the Timeline, select the clips whose audio you want to expand, and choose Clip > Expand 
Audio/Video (or press Control-S).
• Double-click the clip’s audio waveform.Chapter 11 Advanced editing 274
3 Move the playhead to the edit point between the two clips. 
Playhead at edit point
To ensure accurate playhead placement, use keyboard shortcuts:
• To move the playhead to the previous edit point: Press Semicolon (;) or the Up Arrow key.
• To move the playhead to the next edit point: Press Apostrophe (’) or the Down Arrow key.
4 Do one of the following:
• To select both sides of the audio edit point: Press Shift-Backslash (\).
• To select both sides of the video edit point: Press Backslash (\).
Selected audio edit point
5 To roll the audio edit point or the video edit point, do any of the following:
• To nudge the edit point left or right: Press Comma (,) or Period (.), respectively.
• To nudge the edit point 10 frames left or right: Press Shift-Comma (,) or Shift-Period (.), respectively.
• To add or subtract from the current edit using timecode: Press Plus Sign (+) or Minus Sign (–) 
followed by the timecode duration, and press Return.Chapter 11 Advanced editing 275
The timecode entry field (with blue numbers) appears in the Dashboard in the toolbar as you 
type. For more information about entering timecode values, see Navigate using timecode on 
page 144.
Shifted edit point Original edit point
When you play back this section of the Timeline, you hear the man begin to speak before the 
video cuts to the close-up of him. In this way, you can use split edits to create seamless edits 
from one shot to the next.
Make three-point edits
Three-point editing overview
Three-point editing allows you to use start and end points in the Event Browser and the Timeline 
to specify the duration of a clip and where it should be placed in the Timeline. Three-point 
editing gets its name from the fact that only three edit points are necessary to determine the 
portion of the source clip to use and where to place that clip in the Timeline. Final Cut Pro infers 
the fourth edit point automatically. The result of the edit depends on which three points are set 
in the Event Browser and in the Timeline: two start points and one end point or one start point 
and two end points.
You can use three-point editing with the following types of edits: 
• Insert
• Connect
• Overwrite
With each of these edit types, you can also perform backtimed three-point edits, in which the 
end point (rather than the start point) is aligned with the skimmer or playhead position in either 
the Event Browser or the Timeline. You can also make two-point edits in which start and end 
points are inferred from the skimmer position and the clip duration.
To make three-point edits, it’s important to know how to make selections and how to use the 
skimmer and the playhead. For more information about making selections, see Select a range on 
page 93 and Select one or more clips on page 91. For more information about the skimmer and 
the playhead, see Playback and skimming overview on page 73.Chapter 11 Advanced editing 276
Basic three-point editing has three stages:
Stage 1: Set source selection edit points in the Event Browser
Specify which part of a clip you want to place in the Timeline. You do this by setting the start 
and end points. If you want to set just a start point in the Event Browser, position the skimmer 
(or playhead) at the point where you want the edit to begin. In this case, the end point is 
determined by the start and end points set in the Timeline or by the end of the clip. You can also 
select multiple clips in the Event Browser, and their aggregate source media duration determines 
the start and end points.
Stage 2: Set edit points in a storyline in the Timeline
Specify where you want the clip to appear in the Timeline by setting start and end points in the 
primary storyline or in a connected storyline. If both start and end points are set in the Timeline, 
these edit points determine the edit duration, regardless of the duration set in the Event Browser. 
If no start or end points are set in the Timeline, Final Cut Pro uses the skimmer position for the 
start point of the edit. If the skimmer is not present, Final Cut Pro uses the playhead position.
Important: With few exceptions, three-point editing requires range selections (rather than 
clip selections).
Stage 3: Add the source clip or selection to the Timeline
Choose to either insert, connect, or overwrite.
Important: Timeline start and end points always take precedence over start and end points set in 
the Event Browser. This means that if you set both a start point and an end point in the Timeline, 
the Timeline start and end points determine the duration of the edit, regardless of the start and end 
points in the Event Browser. This allows you to limit your edit to a specific section of the Timeline.
There are a few key things to keep in mind when making three-point edits.
Edit points set Results
• Source selection start and end 
points in the Event Browser
• Destination start point in 
the Timeline
The start point of the source selection in the Event Browser is aligned 
with the destination start point in the Timeline, and the duration of the 
edit is determined by the source selection start and end points in the 
Event Browser.
• Source selection start point in 
the Event Browser
• Destination start and end 
points in the Timeline
The start point of the source selection in the Event Browser is aligned with 
the destination start point in the Timeline, and the duration of the edit is 
determined by the destination start and end points in the Timeline.
Note: This edit requires a range selection in the Timeline. You can use the 
Range Selection tool or the I and O keys for this purpose. For more 
information about making range selections, see Select a range on page 93.
• Source selection start and end 
points in the Event Browser
• Destination end point in 
the Timeline
The end point of the source selection in the Event Browser is aligned 
with the destination end point in the Timeline, and the duration of the 
edit is determined by the source selection start and end points in the 
Event Browser.
This is known as “backtiming” an edit. Use this method when you want to 
make sure a clip ends at a specific point in the project. 
• Source selection end point in 
the Event Browser
• Destination start and end 
points in the Timeline
The end point of the source selection in the Event Browser is aligned with 
the destination end point in the Timeline, and the duration of the edit is 
determined by the destination start and end points in the Timeline.
This is known as “backtiming” an edit. Use this method when you want to 
make sure a clip ends at a specific point in the project. 
Note: This edit requires a range selection in the Timeline. You can use the 
Range Selection tool or the I and O keys for this purpose. For more 
information about making range selections, see Select a range on page 93.Chapter 11 Advanced editing 277
Three-point edit examples
In Final Cut Pro, you can make precise edits using a combination of three (or sometimes two) 
edit points set in the Event Browser and the Timeline. For more information, see Three-point 
editing overview on page 275.
Here are a few examples of ways to make three-point edits.
Example: Make a three-point edit
The simplest way to perform a three-point edit is to specify start and end points for the source 
selection in the Event Browser, and then specify the destination start point in your project by 
positioning the skimmer (or the playhead) in the Timeline.
1 Set start and end points for the source selection in the Event Browser.
Start point End point
2 In the Timeline, position the skimmer (or the playhead, if the skimmer is not present) at the 
location in your project where you want the clip to start (the destination start point). 
Position the skimmer at the 
location in the project where 
you want the clip to start.
3 To add the source selection to the project using an overwrite edit, press D.
The new clip starts where 
the skimmer was positioned.
The portion of your source selection between the start and end points appears in the Timeline, 
starting at the skimmer position.
By defining only three points—the source selection start and end points in the Event Browser 
and the destination start point in the Timeline—you have total control of the edit.Chapter 11 Advanced editing 278
Example: Make a backtimed three-point edit
You can make a three-point edit by defining source selection start and end points in the Event 
Browser and a destination end point (instead of a destination start point) in the Timeline. This is 
called backtiming a clip. You can use this method when you want to make sure a particular clip 
ends at a specific point in a project, on a musical beat. In the resulting edit, the end point of the 
media in the Event Browser selection is aligned with the end point you set in the Timeline, and 
the rest of the source selection appears to the left.
1 Set start and end points for the source selection in the Event Browser.
Start point End point
2 In the Timeline, position the skimmer (or the playhead, if the skimmer is not present) at the 
location in your project where you want the clip to end. 
Position the skimmer at 
the location where you 
want the clip to end.
3 Do either of the following:
• To backtime the selection using a connect edit: Press Shift-Q.
• To backtime the selection using an overwrite edit: Press Shift-D.
Your source selection is edited into the project so that the end point of the media in your source 
selection lines up with the end point you specified in the Timeline.
The new clip ends where the 
skimmer was positioned.
The rest of your clip has overwritten any material to the left of the end point for the duration 
defined by the source selection start and end points set in the Event Browser.Chapter 11 Advanced editing 279
Example: Make a three-point edit with multiple clips
You can make three-point edits with multiple clips at a time.
1 In the Event Browser, select two or more clips. (Don’t select a range within a single clip.)
For information about selecting multiple clips, see Select one or more clips on page 91.
Three clips are selected 
to be placed in the storyline. 
No range selection is set.
2 In the Timeline, define a destination start point by positioning the skimmer at the location in 
your project where you want the clip or group of clips to start.
Position the skimmer at the 
location where you want the 
group of clips to begin.
3 To add the selected clips to the project using an overwrite edit, press D.
The new group of clips 
begins where the skimmer 
was positioned.
The playhead moves to the 
end of the new clips.
The entire group of clips selected in the Event Browser has been edited into the project.
Note: The clips are added in the order in which you selected them.
Because you used an overwrite edit, any clip items already in the project are overwritten by the 
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You can also make a three-point edit involving multiple clips in the Timeline. To select a range 
across multiple clips in the Timeline, you use the Range Selection tool or the I and O keys. For 
more information about range selections, see Select a range on page 93.
Example: Make a two-point edit
You can make an edit without any selections in either the Event Browser or the Timeline. This is 
known as a two-point edit. In this case, Final Cut Pro acts on the current clip in the Event Browser 
from the position of the skimmer or playhead to the end of the clip, and on the project in the 
Timeline from the position of the skimmer or playhead forward.
You can also make backtimed two-point edits, in which Final Cut Pro acts on the current clip in 
the Event Browser and the project in the Timeline from the skimmer or playhead position back. 
In either case, the duration of the edit is determined by the skimmer or playhead position and 
the end of the clip in the Event Browser.
1 To specify a source selection start point in the Event Browser, move the skimmer or playhead to 
the location where you want the edit to start (but don’t make any selections).
The Event Browser playhead 
position determines the source 
selection start point.
2 To specify a destination start point in the Timeline, move the skimmer or playhead to the 
location where you want the edit to start (but don’t make any selections).
The skimmer position in the Timeline 
is the destination start point.
3 To add the clip to the project using an overwrite edit, press D.
The new clip starts where the skimmer was positioned.
The new clip starts where 
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Try out clips using auditions
Auditions overview
In Final Cut Pro you can organize related clips into sets, called auditions, from which you can 
choose one clip to use. You can create an audition composed of different clips to try out multiple 
takes, or you can create an audition composed of multiple versions of the same clip to preview 
different effects. Auditions appear in the Event Browser and Timeline as clips with an Audition 
icon in the upper-left corner.
Icon for an audition 
in the Event Browser
Icon for an audition 
in the Timeline
The audition’s filmstrip displays the currently selected clip, called the pick. All other clips in the 
audition are referred to as alternates. You can open an audition to see the selected clip and 
the alternates.
Alternate clips
Selected clip
Auditions allow you to preserve your alternate edits without affecting the other clips in the 
Timeline. When you’re not auditioning the clips in an audition, the audition functions like an 
individual clip. You can trim an audition, apply transitions between auditions and other clips, 
and add keywords and markers. You can keep your audition containing your alternate clips for 
as long as is necessary.
After you’ve reviewed the clips in the audition and decided which one works best in your project, 
you can finalize the audition, which dissolves it and leaves the pick as an individual clip in the 
Timeline. The pick retains the audition’s position in the Timeline and all keywords and markers 
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Create auditions to try out clips
You can create auditions in the Event Browser and then add them to the Timeline, or you can 
create auditions directly in the Timeline. When you create auditions in the Timeline, you can 
either group related clips or group multiple versions of the same clip (for example, to try out 
multiple effect treatments or lower-third titles).
Icon for an audition 
in the Event Browser
Icon for an audition 
in the Timeline
Create auditions in the Event Browser
m Select the clips you want to include in the audition, and choose Clip > Audition > Create (or 
press Command-Y).
Create auditions in the Timeline
m To create an audition with related clips: Drag a clip or a group of clips from the Event Browser onto 
a clip in the Timeline, and choose an audition option from the shortcut menu.
Choosing Add to Audition creates an audition with the current Timeline clip as the pick. 
Choosing Replace and Add to Audition makes the clip you’re dragging the pick.
Important: If a transition is applied to the current clip in the Timeline and the pick for the new 
audition lacks sufficient media for the transition, the transition is either shortened or removed.
m To create an audition with a duplicate version of a clip, including applied effects: Select a clip in the 
Timeline, and choose Clip > Audition > Duplicate as Audition.
An audition is created containing the selected clip and a duplicate version that includes any 
effects applied to the original.
m To create an audition with a duplicate of the original version of a clip, without applied effects: 
Select a clip in the Timeline, and choose Clip > Audition > Duplicate from Original (or press 
Command-Shift-Y).
An audition is created containing the selected clip and a duplicate version without any 
applied effects.
m To create an audition with a duplicate of the original version of a clip, with effects and attributes from 
another clip: Select a clip in the Timeline that has the attributes you want to copy, and choose 
Edit > Copy (or press Command-C). Then select the clip you want to make into an audition and 
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An audition is created containing the selected clip and a duplicate version with effects and 
attributes copied from the first clip.
Open an audition
After you create an audition, it’s easy to open it and review its contents.
Do one of the following:
m Choose Clip > Audition > Open (or press Y).
m Click the Audition icon.
Audition icon
The Audition window appears, and you can preview your clips to choose a pick.
Add and remove clips in auditions
When building auditions to try out different clips or versions of a clip with different effects, you can 
add and remove clips at any time. In the Event Browser and the Timeline, you can add new clips to 
the audition as well as duplicate clips within an audition. When an audition in the Timeline contains 
the clips you want to try out, you can use the audition to preview the clips or effects in your project.
Add clips to an audition in the Event Browser
m To add new clips to an audition in the Event Browser: Select the audition and the clips you want to 
add to it, and choose Clip > Audition > Create (or press Command-Y).
Select the audition.
Select clips to add 
to the audition.
m To duplicate a clip within an audition in the Event Browser: Click the icon in the upper-left corner 
of the audition to open the Audition window, select the clip you want to duplicate, and 
click Duplicate.
Select the clip you 
want to duplicate, 
and click Duplicate.
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Add new clips to an audition in the Timeline
m To add a new clip to an audition and maintain the current clip in the Timeline as the pick: Drag a clip 
from the Event Browser to the audition in the Timeline, and choose Add to Audition from the 
shortcut menu.
m To add a new clip to an audition and make the clip you’re adding the pick: Drag a clip from the 
Event Browser to the audition in the Timeline, and choose Replace and Add to Audition from the 
shortcut menu.
Important: If a transition is applied to the current clip in the Timeline and the pick for the new 
audition lacks sufficient media for the transition, the transition is either shortened or removed.
m To duplicate a clip within an audition: Click the Audition icon in the upper-left corner of the 
audition to open the Audition window, select the clip you want to duplicate, and click Duplicate 
(or press Command-Shift-Y).
Select the clip you 
want to duplicate, 
and click Duplicate.
A new version of the selected clip appears in the Audition window.
m To add a duplicate of the original version of an audition pick, with effects and attributes from another 
clip: Select a clip in the Timeline that has the attributes you want to copy, and choose Edit > Copy 
(or press Command-C). Then select the audition and choose Clip > Audition > Duplicate and 
Paste Effects (or press Command-Option-Y).
Remove a clip from an audition
1 To open the audition containing the clip you want to remove, click the icon in the upper-left 
corner of the audition.
2 In the Audition window, select the clip you want to remove, and press Delete.
The clip is removed from the audition. 
Use auditions to try out clips in your project
You create an audition to try out the clips within it and find the one that works best for your 
project. Although the auditioning workflow may differ from project to project, the general 
process is the same. You create an audition that contains a set of alternate takes, effects, or 
text treatments, and then you choose the best clip for the edit by making it the pick. When 
you’re sure of your decision, you finalize the audition, which dissolves it and leaves the pick in 
the Timeline.
Depending on your workflow, you may try out the clips within your auditions and flatten the 
auditions as you go, or you may leave the auditions in the Timeline for the purpose of showing 
alternate edits to a client.
Note: You can use audition commands only with one selected audition at a time. For example, 
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Review clips within an audition in the Timeline
1 In the Timeline, select the audition containing the clips you want to review, and open it by 
choosing Clip > Audition > Open (or pressing Y).
The clip under the spotlight 
in the center of the window 
is the pick.
2 In the Audition window, select the pick and press the Space bar (or press Command-Control-Y) 
to play it.
3 To play an alternate clip in the Viewer, select a clip to the right or left of the pick (or press the 
Right Arrow or Left Arrow key).
The alternate becomes 
the new pick and plays 
back in the Viewer.
The star icon indicates 
the previous pick.
Tip: To quickly move through and play alternate clips, select a closed audition in the Timeline, 
press the Space bar, and press Control-Left Arrow to play clips to the left of the current pick, or 
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4 When you decide on the clip you want to use, make sure it’s selected under the spotlight, and 
click Done.
5 If you’re sure of your decision and want to finalize the audition, choose Clip > Audition > Finalize 
Audition (or press Shift-Option-Y).
The audition is dissolved, leaving the pick in the Timeline. The clip selected as the pick retains any 
keywords or markers assigned to the audition.
Try out multiple effects on a clip in the Timeline
You can try out effects on a clip in the Timeline by creating an audition and adding individual 
effects to duplicates of the same clip. This technique allows you to view each effect in relation to 
the clips that precede and follow the audition in the Timeline. 
1 In the Timeline, select the clip you want to try different effects on.
2 Choose Clip > Audition > Duplicate as Audition (or press Option-Y).
3 Repeat step 2 for each effect that you want to audition.
4 To open the Audition window, click the icon in the upper-left corner of the audition (or press Y).
5 To open the Effects Browser, click the Effects button in the toolbar (or press Command-5).
6 In the Audition window, select the version of the clip you want to apply the effect to.
7 In the Effects Browser, select the effect you want to try out, and drag it to the clip in the 
Audition window.
Drag an effect from the 
Effects Browser to a clip 
in the Audition window.
8 Repeat steps 6 and 7 until you’ve applied all the effects you want to audition.Chapter 11 Advanced editing 287
9 Review each effect’s impact on the clip in the Timeline by selecting a clip to the right or left of 
the pick.
Click an alternate clip 
to play it in the Viewer.
Tip: To quickly move through and play alternate clips, press Control-Left Arrow to play clips to 
the left of the current pick, or Control-Right Arrow to play clips to the right.
10 When you decide on the effect you want to use, select the clip with that effect in the Audition 
window, and click Done.
11 If you’re sure of your decision, and want to finalize the audition, choose Clip > Audition > Finalize 
Audition (or press Shift-Option-Y).
The audition is dissolved, leaving the clip with your chosen effect applied to it in the Timeline.
Tip: To save time, you can have Final Cut Pro automatically duplicate a clip in the Timeline and 
apply an effect to the duplicated clip by holding down the Control key while you drag an effect 
from the Effects Browser to the clip in the Timeline. You can also apply an effect to every clip in 
an audition by holding down the Option key and the Control key while you drag the effect from 
the Effects Browser to the audition in the Timeline. In both cases, you must start dragging the 
effect from the Effects Browser and then press the keys as you add the effect to the clip.
Retime clipsto create speed effects
Retiming clips overview
You can adjust a clip’s speed settings to create fast-motion or slow-motion effects. You can also 
reverse a clip, rewind a segment of a clip, apply variable speed effects (also called speed ramping) 
to a clip selection, and create instant replays. By default, Final Cut Pro maintains the audio pitch 
of any speed adjustment, but you can turn this feature off to accentuate the speed effect.
You can’t apply speed changes to still images, generators, titles, and themes in Final Cut Pro.Chapter 11 Advanced editing 288
Change clip speed
In Final Cut Pro you can make both constant and variable speed changes to your clips while 
preserving the audio’s pitch. 
Note: Speed settings are applied to the specific instance of the selected clip only. They are not 
applied to that clip’s source media file on disk. To create a media file with the applied speed 
effects, export the clip as a QuickTime movie. For more information, see Share projects, clips, and 
ranges on page 378.
Apply a constant speed change
Applying a constant speed change to a range selection or a whole clip alters the entire 
selection’s playback speed by the same percentage. For example, applying a speed setting of 25 
percent to the selection makes the entire selection play in slow motion. 
Constant speed changes also alter the duration of a clip. If a constant speed change causes the 
duration of a clip in your project to become longer or shorter, all clips coming after it ripple 
forward or backward. If you change the speed to 50 percent, your clip is twice as long; if you 
change the speed to 200 percent, the clip is half as long. For example, if you set a 5-second 
clip to play back at 50 percent speed, Final Cut Pro adds frames to the clip so that the clip 
becomes 10 seconds long and plays back more slowly. If you increase the clip’s speed to 200 
percent, Final Cut Pro removes frames and makes the clip 5 seconds long, and it plays back 
considerably faster.
Same clip with speed 
changed to 50 percent 
(now 10 seconds long)
5-second clipChapter 11 Advanced editing 289
1 In the Timeline, select a range, a whole clip, or a group of clips whose speed you want to change.
2 Do one of the following:
• To apply a preset speed setting: Choose Slow or Fast from the Retime pop-up menu in the 
toolbar (shown below), and choose a speed from the submenu.
• To apply a custom speed setting: Choose Show Retime Editor from the Retime pop-up menu (or 
press Command-R) to display the Retime Editor above the selection in the Timeline, and drag 
the retiming handle.
If you drag the retiming handle to the right, the speed of the selection decreases, the duration 
of the selection increases, and the bar above the Timeline selection turns orange.
Drag the retiming handle 
to the right to create 
a slow-motion effect.
If you drag the retiming handle to the left, the speed of the selection increases, the duration of 
the selection decreases, and the bar above the Timeline selection turns blue.
Drag the retiming handle 
to the left to create a 
fast-motion effect.Chapter 11 Advanced editing 290
Apply a variable speed change
To alter the speed of a clip over time, in forward or reverse motion, you can apply a variable 
speed change (also called speed ramping). Variable speed changes create sophisticated effects 
in which subjects appear to smoothly shift across a variety of different speeds, with gradual or 
abrupt transitions between each speed segment. These types of effects can be seen in many 
music videos and broadcast commercials, and the effects can be created directly in the Timeline. 
To apply variable speed effects, you divide a clip into speed segments that are set to specific 
speed percentages.
1 In the Timeline, select either a range within a clip or a whole clip to which you want to apply a 
speed ramp effect.
2 Do one of the following:
• To ramp the speed down: Choose Speed Ramp > “to 0%” from the Retime pop-up menu in 
the toolbar.
• To ramp the speed up: Choose Speed Ramp > “from 0%” from the Retime pop-up menu in 
the toolbar.
The selection is segmented into four parts with different speed percentages, creating the 
ramp effect. If more precision is required, you can manually drag any one of the four retiming 
handles to set the speed you want.
Drag a retiming handle to 
modify the speed percentage 
of a speed ramp segment.
Preserve audio pitch in retimed clips
By default, Final Cut Pro is set to preserve the audio pitch of a clip that has been retimed. 
However, if you want to accentuate the retiming adjustment’s effect by allowing the pitch to 
change in accordance with the retiming adjustment, you can turn this feature off.
1 In the Timeline, select a range, a whole clip, or a group of clips whose speed you plan to change.
2 Choose Preserve Pitch from the Retime pop-up menu in the toolbar.
A checkmark to the left of the command name indicates that Preserve Pitch is turned on. Choose 
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Change the end frame of a speed segment
You can change the end frame of a speed segment in the Timeline.
When you drag the retiming handle of a speed segment, you’re adjusting the speed of the 
segment, not trimming it. The Change End Source Frame command allows you to trim the end 
point (end frame) of a segment.
1 In the Timeline, select a clip that has speed segments.
2 To display the Retime Editor above the clip in the Timeline, choose Show Retime Editor from the 
Retime pop-up menu in the toolbar (or press Command-R).
3 Click the triangle next to the speed percentage for a speed segment, and choose Change End 
Source Frame from the pop-up menu.
A filmstrip icon appears over the end frame of the speed segment.
4 To change the end frame, drag the filmstrip icon left or right.
Filmstrip icon
As you drag, the Viewer displays the current end frame.
Conform a clip’s speed to match the project’s speed
If you’ve applied speed effects using your camera, the native speed of the source media may 
not match the native speed of the source media for the rest of the clips in your project in the 
Timeline. However, you can change the clip with the differing native speed to match the rest of 
the clips in the Timeline.
1 In the Timeline, select the clip whose speed you want to change to match the rest of the clips in 
your project.
2 Choose Conform Speed from the Retime pop-up menu in the toolbar.Chapter 11 Advanced editing 292
Smooth out a slow-motion clip with video quality presets
To smooth out the apparent motion of a clip playing back in slow motion, you can apply frame 
blending or optical flow analysis to the retimed clip.
1 In the Timeline, select a range, a whole clip, or a group of clips whose video quality you want 
to change.
2 Choose a Video Quality setting from the Retime pop-up menu in the toolbar.
• Normal: The default setting. Frames are duplicated, and no frame blending is applied to the 
slow-motion clip. No rendering is required.
• Frame Blending: Adds in-between frames by blending individual pixels of neighboring frames. 
Slow-motion clips created with Frame Blending appear to play back more smoothly than 
those created with the Normal (duplication) setting. Rendering is required.
• Optical Flow: Adds in-between frames using an optical flow algorithm, which analyzes the clip 
to determine the directional movement of pixels and then draws portions of the new frames 
based on the optical flow analysis. Only the portion of the clip used in the project (the media 
between the clip start and end points) is analyzed. Rendering is required.
Note: The more motion contained in a clip, the longer the analysis and rendering takes.
Reverse or rewind clips
In addition to changing the speed of a clip, you can also add directional effects:
• Reverse: Reverses the order of frames in the clip, so that the last frame plays first.
• Rewind: Appends a duplicate of the range selection or clip as a segment, rewinds the 
duplicated segment at 1x, 2x, or 4x speed, and then plays the original clip segment again in 
forward motion at normal speed.
Reverse a clip
1 In the Timeline, select a clip or a group of clips whose contents you want to reverse.
2 Choose Reverse Clip from the Retime pop-up menu in the toolbar.
The green bar with arrows pointing to the left above the selection in the Timeline indicates that 
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3 If you want to adjust the speed of the reversed clip, drag the retiming handle to the left to 
increase the speed or to the right to decrease it.
Reversed segment
Drag the retiming 
handle to change 
the speed of the 
reversed clip.
4 To see the reverse effect, play back the reversed clip or selection.
Rewind a range selection or clip
1 In the Timeline, select a range, a whole clip, or a group of clips whose contents you want 
to rewind.
2 Choose Rewind from the Retime pop-up menu in the toolbar (shown below), and choose a 
speed from the submenu.
The selection is duplicated, added to the end of the original selection, and then reversed 
according to the speed choice. An additional duplicate of the Timeline selection follows the 
reversed section and plays back in forward motion at the selection’s original speed.
3 If you want to adjust the speed of the rewound section or the sections that precede and follow 
the rewound section, drag the section’s retiming handle to the left to increase the speed or to 
the right to decrease it.
Drag a retiming handle 
to change the speed.
4 Play the clip back to review the rewind effect.Chapter 11 Advanced editing 294
Create instant replays
You can apply an instant replay to a range selection within a clip or a whole clip. Final Cut Pro 
duplicates the range or clip, appending the duplicated frames to the end of the selection as a 
new segment. You can then modify the speed of the new segment to achieve the instant replay 
effect you’re looking for.
Create an instant replay
1 In the Timeline, select a range or a whole clip whose contents you want to use to create an 
instant replay.
2 Choose Instant Replay from the Retime pop-up menu in the toolbar.
A duplicate of the range or clip is appended to the end of the selection and plays back in 
forward motion at the selection’s original speed. (By default, the instant replay is set to play 
back at 100 percent speed.)
3 If you want to adjust the speed of the instant replay segment, drag the retiming handle to the 
left to increase the speed or to the right to decrease it.
Original clip
(now a segment)
Instant replay segment set to 
a manual slow-motion setting
Drag the retiming handle to 
change the speed of the 
instant replay segment.
4 To see the instant replay effect, play back the original selection and the instant replay segment.
Create a hold segment
In Final Cut Pro, you can hold on a particular frame to create a still image, temporarily stopping 
the action onscreen. By default, Final Cut Pro adds a 2-second still frame, called a hold segment, at 
the location of the skimmer or playhead, but you can change the duration of the hold segment 
at any time.
Alternatively, you can create separate freeze-frame clips in Final Cut Pro. One key difference 
between freeze frames and hold segments is that hold segments remain part of the original 
clip and their duration can be adjusted within the clip. For more information, see Create freeze 
frames on page 113.
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Create a still-image hold segment
1 In the Timeline, do one of the following: 
• Select the clip with the frame you want to hold, and move the skimmer or playhead to 
that frame.
• Select a range within a clip in the Timeline.
2 Choose Hold from the Retime pop-up menu in the toolbar (or press Shift-H).
If you selected a clip, a 2-second hold segment is added to the clip at the position of the 
skimmer or the playhead.
If you selected a range, a hold segment is created for the duration of the range. The frame used 
as the still frame is the first (leftmost) frame in the range.
3 If you want to adjust the duration of the hold segment, drag the segment’s retiming handle to 
the right to increase the duration, or to the left to decrease it.
Drag the retiming handle 
to change the duration 
of the hold segment.
4 To see the effect of the hold segment, play back the clip in the Timeline.
Reset retimed clips to play at normal speeds
You can reset a range selection or a clip to play back at normal (100 percent) speed at any time. 
Resetting the speed removes any directional effects and Holds applied to the selection at the 
same time.
Reset a range or a clip to play forward at 100 percent
1 In the Timeline, select a range, a whole clip, or a group of clips that you want to reset to their 
original speed.
2 Choose Normal 100% from the Retime pop-up menu in the toolbar (or press Shift-N).Chapter 11 Advanced editing 296
Conform frame sizes and frame rates
Final Cut Pro manages project settings automatically. This means you can work with multiple 
media types with differing frame sizes (also referred to as resolution) and frame rates in the same 
project. When you add the first video clip to your project, Final Cut Pro automatically sets the 
format, frame size, and frame rate for the entire project based on the properties of that first clip 
(or, more precisely, on the properties of the clip’s source media file). 
You can modify the project’s settings at any time, and you can control, on a clip-by-clip basis, 
how Final Cut Pro conforms an individual clip’s frame rate and frame size to match the project 
settings. All of the project information in this section applies equally to compound clips, which 
can have their own distinct project settings.
You can add interlaced clips to progressive (non-interlaced) projects and progressive clips to 
interlaced projects. To add an interlaced clip to a progressive project, see the instructions below. 
Final Cut Pro accepts progressive clips in interlaced projects automatically.
Here are things to keep in mind when working with multiple formats and frame sizes:
• Choose video and audio project properties based on how you intend to share your final movie 
with your audience. For example, if you’re editing a project with mixed-format media and you 
intend to share it as 1080p HD, you should set your project’s video properties to 1080p HD.
• If you’re unsure of the final distribution format, the most important decision you can make 
before creating your project is choosing your project’s frame rate. It’s easy to change the 
format and the frame size of your project at any time, but changing the frame rate can cause 
all the edit points in your project to shift in time.
• If you have a clip that matches the video and audio properties of the format in which you 
intend to share your project, add this clip to your project first. Final Cut Pro automatically 
creates matching project settings. This saves you time by preventing you from having to 
change your project settings later.
Tip: If the first clip you add to a project is an audio clip or a still-image clip, Final Cut Pro 
prompts you to choose the video properties for your project. Cancel the edit, add a video clip 
whose source media file has the video properties you require for your project, and then add 
the non-video clip to your project.
Choose a method of conforming frame size
You can choose how Final Cut Pro modifies the frame size of a clip to match the project’s frame 
size settings. For example, you can have Final Cut Pro change the frame size of the clip to fit 
within the longest dimension of the project’s frame dimensions, fill the entire frame of the 
project (which usually results in cropping), or leave the clip’s frame size as is.
1 Add a clip to the Timeline with a frame size that doesn’t match the current project’s frame size 
(resolution) settings.
2 Select the clip in the Timeline.
3 To open the Video inspector, click the Inspector button in the toolbar (shown below), and click 
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4 Choose a method of conforming frame size from the Type pop-up menu in the Spatial Conform 
section of the Video inspector.
• Fit: The default setting. Fits the clip within the project’s frame size setting without cropping the 
clip’s video. Black bars appear on the sides of the frames that don’t match the project’s frame 
size (resolution). In the case of a standard-definition (SD) clip in a high-definition (HD) project, 
Final Cut Pro scales up the SD clip to fit the HD project’s frame size. In the case of an HD clip in 
an SD project, Final Cut Pro scales down the HD clip to fit the SD project’s frame size.
• Fill: Makes the clip’s video fill the project’s frame size. In the case of an SD clip in an HD project, 
Final Cut Pro scales up the SD clip to fit the HD project’s frame size. Cropping occurs along 
the clip’s longer dimension to allow the shorter dimension to fill the screen. In the case of an 
HD clip in an SD project, Final Cut Pro scales down the HD clip to fit the SD project’s frame 
size. Cropping occurs along the clip’s shorter dimension to allow the longer dimension to fill 
the screen. 
• None: Leaves the clip’s frame size unchanged. If the clip’s frame size is larger than the the 
project’s frame size, the clip appears cropped. If the clip’s frame size is smaller than the 
project’s frame size, black bars surround the clip.
Choose a method of conforming frame rate
When a clip’s frame rate differs from the project’s frame rate, Final Cut Pro employs a framesampling method to change the clip’s frame rate to match that of the project. You can choose 
which frame-sampling method Final Cut Pro uses to modify the clip’s frame rate. The method you 
choose depends on how important it is to you to eliminate visual stuttering and visual artifacts.
1 Add a clip to the Timeline with a frame rate that doesn’t match the current project’s frame 
rate settings.
2 Select the clip in the Timeline.
3 To open the Video inspector, click the Inspector button in the toolbar (shown below), and click 
the Video button at the top of the pane that appears.
4 Choose a method of conforming frame rate from the Frame Sampling pop-up menu in the Rate 
Conform section of the Video inspector.
Note: If the selected clip has the same frame rate as the project frame rate settings, the Rate 
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• Floor:The default setting. Final Cut Pro truncates down to the nearest integer during its 
calculation to match the clip’s frame rate to the project’s frame rate.
• Nearest Neighbor:Final Cut Pro rounds to the nearest integer during its calculation to match 
the clip’s frame rate to the project’s frame rate. The Nearest Neighbor option reduces artifacts 
at the expense of visual stuttering. Rendering is required.
• Frame Blending:Creates in-between frames by blending individual pixels of neighboring 
frames. Slow-motion clips created with Frame Blending appear to play back more smoothly 
than those created with the Floor or Nearest Neighbor setting. This setting provides better 
reduction of visual stuttering, but you may see some visual artifacts. Rendering is required.
• Optical Flow:A type of frame blending that uses an optical flow algorithm to create new 
in-between frames. Final Cut Pro analyzes the clip to determine the directional movement 
of pixels, and then draws portions of the new frames based on the optical flow analysis. 
Choosing the Optical Flow option results in better reduction of visual stuttering, and 
Final Cut Pro spends a significant amount of time to fix visual artifacts.
Add an interlaced clip to a non-interlaced (progressive) project
Some video formats use an interlaced scanning method that divides a video frame into two 
fields, each consisting of alternating odd and even lines that are scanned at different times. 
If you want to add an interlaced clip to a progressive project, you can have Final Cut Pro 
deinterlace the clip so that it plays at full resolution, free of the alternating jagged lines 
associated with interlaced clips in progressive projects.
1 Do one of the following:
• In the Event Browser, select the interlaced clips you want to add to a progressive project.
• In the Timeline, select interlaced clips you’ve added to a progressive project.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 In the Info inspector, choose Settings View from the Metadata View pop-up menu.
4 Select the Deinterlace checkbox.
Note: Selecting the Deinterlace setting causes the frame rate of the selected clips to double. For 
example, if the original interlaced clips have a frame rate of 29.97 fps, the deinterlaced clips will 
have a frame rate of 59.94 fps. Keep this in mind when you choose the video and audio settings 
for your project.
Tip: To confirm the absence of interlacing artifacts, you can press the Left Arrow and Right Arrow 
keys to step through the clips in the Timeline one frame at a time.
5 Choose Final Cut Pro > Preferences, click Playback, and choose High Quality from the Playback 
Quality pop-up menu.
The clips now play back and function as progressive clips. Depending on your specific computer 
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Adjust anamorphic footage
Some video camcorders and recording devices shoot at a widescreen 16:9 aspect ratio but record 
the data using a 4:3 aspect ratio. Sometimes the metadata tag specifying 16:9 playback in the 
video file is missing or set incorrectly. In Final Cut Pro, you can set this tag so that the video plays 
correctly with a widescreen 16:9 aspect ratio.
Note: This option applies only to (and appears only with) standard-definition (SD) formats.
1 In the Event Browser or the Timeline, select the SD clips whose anamorphic setting you want 
to adjust.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 Choose Settings View from the Metadata View pop-up menu at the bottom of the Info inspector.
4 In the Anamorphic Override pop-up menu, choose Widescreen.
The clips now play back and function with the widescreen 16:9 aspect ratio.
Use rolesto manage clips
Roles overview
Roles are metadata text labels that you assign to clips in the Event Browser or the Timeline, and 
they provide a flexible and powerful way to manage your editing workflow. You can use roles 
in Final Cut Pro to organize clips in your events and projects, control the appearance of the 
Timeline, and export separate video or audio files (also known as media stems) for distribution, 
audio mixing, or post-production.
When you import clips (video, audio, or still images), Final Cut Pro analyzes existing clip metadata 
to assign one of five default roles to the video and audio components of each clip: Video, Titles, 
Dialogue, Music, and Effects. For example, if a source media file has an iTunes “genre” metadata 
tag, Final Cut Pro assigns the Music role to the resulting clip. Final Cut Pro assigns the Video and 
Dialogue roles to clips that contain both video and audio.
You can use roles for the following workflows:
• Reassign roles: You can view and reassign clip roles in the Timeline Index, the Event Browser, 
the Info inspector, or the Modify menu. See View and reassign roles on page 300. You can also 
create custom roles and subroles to further organize your clips. 
• View clips by role: In the Timeline Index, you can organize clips by role, turn roles on or off, and 
highlight or minimize clips for viewing in the Timeline. For example, you could easily identify 
all your dialogue clips and play them back in isolation from other audio clips. See View clips by 
role in the Timeline on page 305.
• Export media stems: You can export roles as media stems in a combined, multitrack QuickTime 
file, or as separate audio or video files. During the export process you can assign mono, stereo, 
or surround output for your audio channels. See Destinations preferences on page 422.Chapter 11 Advanced editing 300
View and reassign roles
You can view and change the roles that are assigned to clips in the Event Browser, the Timeline 
Index, the Info inspector, or the Modify menu.
Keep in mind the following when using roles:
• Every clip must have at least one assigned role (clips with audio and video always have one 
audio and one video role). Still images are assigned the Video role by default, but you can 
create a custom (still image) role and assign it to your still images.
• Video roles can’t be assigned to audio-only clips, and audio roles can’t be assigned to 
video-only clips.
• Roles can be assigned to audio or video components of a clip, but can’t be assigned to a clip 
range or a portion of a clip.
• You can view and reassign the role of an audio component in the Info inspector (or by using 
the Modify menu when the clip that contains the audio component is in the Timeline).
• You can assign different roles to each instance of a clip. For example, if you add a clip from the 
Event Browser to the Timeline, copy clips between events, or copy clips within the Timeline, 
each of these clip instances (copies) is independent of the others.
View and reassign roles in the Event Browser
1 In the Event Browser in list view, select one or more clips.
Note: If the Roles column isn’t visible in the Event Browser, Control-click a column heading and 
choose Roles from the shortcut menu.
2 In the Roles column, click the assigned role for a clip to see a shortcut menu listing the 
available roles.
3 To change the role assignments for the selected clips, choose different roles from the 
shortcut menu.
View and reassign roles in the Info inspector
1 Select one or more clips in the Event Browser or the Timeline.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
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3 In the Info inspector, click the Roles pop-up menu to see the available roles.
4 To change the role assignments for the selected clips, choose different roles from the Roles 
pop-up menu.
View and reassign roles in the Timeline Index
1 To open the Timeline Index, click the Timeline Index button in the lower-left corner of the 
Final Cut Pro main window (or press Command-Shift-2).
2 To open the Clips pane, click the Clips button at the top of the Timeline Index. 
3 If the Roles column is not visible in the Clips pane, Control-click a column heading and choose 
Roles from the shortcut menu.
4 Select one or more clips in the Clips pane.
5 To change the role assignments for the selected clips, click the assigned role and choose different 
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View and reassign roles with the Modify menu
1 Select one or more clips in the Event Browser or the Timeline.
2 Choose Modify > Assign Roles, and choose a role from the submenu.
A checkmark appears next to the role you chose.
View and reassign the role of an audio component
1 Select a clip in the Timeline, and choose Clip > Expand Audio Components (or press 
Option-Control-S).
Audio components
2 Select an audio component.
3 To change the role assignment for the selected component, do one of the following:
• Choose Modify > Assign Roles, and choose a role from the submenu.
A checkmark appears next to the role you chose.
• Open the Info inpector, and choose a different role from the Roles pop-up menu.
A checkmark appears next to the role you chose.
For more information about audio components, see About audio channels and audio 
components on page 159.
View and reassign roles in compound clips
Compound clips reflect the roles of the original clips that make up the compound clip. You can 
view and reassign the roles of clips inside a compound clip, but you cannot assign roles to the 
compound clip itself. 
1 Select a compound clip in the Event Browser or the Timeline.
2 To view the assigned roles or to assign a role to every clip inside the compound clip, use the 
following methods:
• Roles column in the Event Browser in list view: Follow the instructions in “View and reassign roles 
in the Event Browser,” above.
• Roles pop-up menu in the Info inspector: Follow the instructions in “View and reassign roles in 
the Info inspector,” above.
• Roles column in the Clips pane of the Timeline Index: Follow the instructions in “View and 
reassign roles in the Timeline Index,” above.
• Assign Roles command: Follow the instructions in “View and reassign roles with the Modify 
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When you assign a role to a compound clip (the container), the role is assigned to every clip 
inside the compound clip. If you want to assign different roles to specific clips within the 
compound clip, you can open the compound clip for editing and then assign roles to individual 
clips inside the compound clip.
For more information about compound clips, see Compound clips overview on page 257.
Create custom roles and subroles
You can create custom roles and subroles in addition to the five default roles (Video, Titles, 
Dialogue, Music, and Effects).
Important: Create custom roles and subroles with care. Custom roles (and the names of custom 
roles) cannot be edited or removed from the roles list. However, you can change the role 
assignments of clips at any time.
Create custom roles
1 To open the Role Editor, do one of the following:
• Choose Modify > Edit Roles.
• In the Event Browser in list view or the Clips pane of the Timeline Index, click a role in the 
Roles column and choose Edit Roles from the shortcut menu.
• With a clip selected in the Event Browser or the Timeline, open the Info inspector and choose 
Edit Roles from the Roles pop-up menu.
2 Choose the role type from the Add Role pop-up menu in the lower-left corner of the Role 
Editor window.
The new role appears at the bottom of the Role column.Chapter 11 Advanced editing 304
3 Type a name for the new role.
Once you have created a new role, it appears in the roles list so that you can assign it to any clip.
Create subroles
Subroles allow you to organize roles within a role; for example, you could create a Foley Effect 
subrole within the Effects role, or a Spanish Subtitles subrole within the Titles role.
1 To open the Role Editor, do one of the following:
• Choose Modify > Edit Roles.
• In the Event Browser in list view or the Clips pane of the Timeline Index, click a role in the 
Roles column and choose Edit Roles from the shortcut menu.
• With a clip selected in the Event Browser or the Timeline, open the Info inspector and choose 
Edit Roles from the Roles pop-up menu.
2 Select a role in the Role column, and click the Add Subrole button (with a plus sign) below the 
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3 Type a name for the subrole.
The new subrole remains in the Subrole list and appears below its parent role in roles lists 
elsewhere in Final Cut Pro. When you assign subroles to clips in the Timeline, the subroles also 
appear in the Timeline Index.
Subroles
View clips by role in the Timeline
You can use the Roles pane of the Timeline Index to view and play back clips by role in 
the Timeline.
All video and audio clips are organized by the default roles of Video, Titles, Dialogue, Music, or 
Effects, or by a custom role or subrole you’ve created. You can turn off roles to suspend playback 
for all clips with those roles assigned. For example, you could turn off all roles except Dialogue to 
play back only dialogue clips, and then turn on the Music role to listen to the movie soundtrack 
along with the dialogue.
Roles give you a powerful way to organize and preview clips before exporting them as files for 
broadcast or audio post-production.
Note: Turning roles on or off in the Timeline Index does not affect export settings or clip settings 
in the Event Browser, the Timeline, or the inspectors.
Turn roles on or off
1 In the Timeline Index, click the Roles button.
2 In the Roles pane, select the checkboxes next to the roles or subroles you want to turn on. 
Deselect the checkboxes next to the roles or subroles you want to turn off.Chapter 11 Advanced editing 306
Active roles appear in color in the Timeline, and inactive roles appear gray. If you turn off all video 
or all audio roles, the respective portion of audio-video clips also appears gray.
Clips assigned an active 
role appear in color.
Clips assigned an inactive 
role appear in gray.
Active roles
3 To preview clips by role, play back your project. 
Only clips with active roles assigned play back.
Highlight roles in the Timeline
1 In the Timeline Index, click the Roles button.
2 In the Roles pane, click the name of the role you want to highlight. 
The clips with this role assigned are highlighted in the Timeline. This includes both active (color) 
clips and inactive (gray) clips.
Selected role Clips assigned a selected 
role appear highlighted.
Tip: To highlight more than one role at a time, Shift-click to select contiguous items and 
Command-click to select noncontiguous items.Chapter 11 Advanced editing 307
Minimize clips by role
To make more space to view and work with clips in the Timeline, you can minimize clips with a 
particular role assigned. Minimized clips appear smaller in the Timeline. 
1 In the Timeline Index, click the Roles button.
2 In the Roles pane, click the Minimize button next to the role whose clips you want to minimize.
Minimize button Minimized clip
Roles that have 
been minimized
You can also customize the display of clips in the Timeline by changing the clip appearance 
and height, and you can choose whether to view clips by name or role. See Adjust Timeline 
settings on page 141. 
Use roles to export media stems
When you export your work, you can use roles to define the details of your output media files. 
This process is often used when delivering files to match broadcast specifications or when 
handing off media stems for mixing or post-production.
You can export roles in a combined, multitrack QuickTime file, or as separate audio or video 
files. During the export process you can assign mono, stereo, or surround output for your 
audio channels.
For more information, see Destinations preferences on page 422.
Use XML to transfer projects and events
Final Cut Pro can import and export XML (Extensible Markup Language) files. You can use XML 
documents (plain ASCII text files with tagged elements) to transfer the details of your events 
and projects between Final Cut Pro and third-party applications, devices, and media asset 
management tools that do not recognize Final Cut Pro events or projects.
The XML import and export options are described in detail in the Final Cut Pro XML developer 
documentation. For more information, visit the Apple Applications page at the Apple Developer 
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Import XML into Final Cut Pro
You can generate XML files with other applications and then import them into Final Cut Pro. 
When you import XML into Final Cut Pro, clips, events, and projects are automatically generated 
in Final Cut Pro. 
1 In Final Cut Pro, choose File > Import > XML.
2 Navigate to the XML file you want to import, and click Import.
Final Cut Pro processes the XML and generates clips, events, and projects in the Event Library and 
the Project Library.
Export XML from Final Cut Pro
You can export events and projects as XML files.
1 In the Event Library or the Project Library, select one or more events or projects that you want to 
export as XML files.
2 Choose File > Export XML.
3 In the window that appears, navigate to a folder on your hard disk where you want to store the 
XML files, and click Save.
Edit with multicam clips
Multicam editing overview
You can use Final Cut Pro to edit footage from multicamera shoots or other synchronized 
footage in real time. For example, if you shot a live concert or a wedding with four different 
cameras, you can synchronize the footage from each camera angle into a single multicam clip 
and cut between the angles in real time.
The angles in a multicam clip are synchronized by a common sync point, a frame that you can 
recognize (visibly or audibly) in each of the angles you are synchronizing. When you add a 
multicam clip to the Timeline, the angle that appears in the Viewer when you play your project 
is called the active angle. While the active angle plays in the Viewer, you can also view all angles 
playing simultaneously in the Angle Viewer and easily cut and switch between them.
Angle 1
Angle 2 Active angle
Angle 3
Angle 4
Sync point
Multicam clip
Working with multicam clips in Final Cut Pro is a flexible and fluid process. At any time, you can 
add angles to or remove angles from a multicam clip, and easily adjust the synchronization 
between angles.
You can also group unrelated footage together for real-time montage editing (such as for music 
videos). For example, if you’re editing a music video, you could add several angles of abstract 
visuals and cut to those angles at specific places in the music. You can even use photos (from 
a still camera) in a multicam clip. If the date and time (Content Created) information matches 
the contents of the other angles, the photos are automatically adjusted in duration to “fill in” 
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Multicam clips have the following characteristics:
• You create multicam clips in the Event Browser only, from existing event clips. 
• You edit and adjust multicam clips in the Angle Editor, which looks similar to the Timeline.
• When you add a multicam clip to the Timeline, you create a direct and active relationship 
between the “parent” multicam clip in the Event Browser and the “child” multicam clip in 
the Timeline.
Event clips
Project 1 Project 3
Child clip Child clips Child clip
Project 2
Parent multicam clip
• When you open any multicam clip in the Angle Editor (whether from the Event Browser or 
the Timeline) you are in fact opening the parent multicam clip from the Event Browser. Any 
changes you make to a multicam clip in the Angle Editor are inherited by all of its child clips, 
in all projects. These changes include sync or trimming adjustments, clip speed retiming, 
video or audio effects such as color correction, and added or deleted angles. For example, if 
you delete an angle from a parent multicam clip, the angle is deleted from all child clips. For 
more information about the Angle Editor, see Sync and adjust angles and clips in the Angle 
Editor on page 324.
Multicam editing workflow
The process for creating a multicam project is outlined below. The procedures are presented in 
rough chronological order, but you can rearrange the order to suit your workflow.
Shoot an event with multiple cameras and record appropriate sync information
A multicamera shoot uses multiple cameras to record the same subject or event from different 
angles and distances.
For multicam projects, it’s a good idea to set the date, the time, and the time zone on your 
camcorder or recording device before you shoot footage for your multicam project. This provides 
useful information to Final Cut Pro during the automatic multicam clip creation process.
In professional multicamera shoots, each camcorder or VTR receives the same timecode from 
a master timecode generator, or you can jam sync the timecode generator of each camera at 
the beginning of the shoot. If you’re using consumer camcorders, which cannot accept external 
timecode, you need to record a visible or audible cue, such as a clapboard closing or a camera 
flash, on all cameras. You can use this cue to synchronize the angles in your multicam clips.
Because you can use the sophisticated automatic audio sync feature in Final Cut Pro to help ensure 
multicam synchronization accuracy, it makes sense to record audio on every camcorder and 
recording device in your multicam production. (Clear audio recordings provide the best results.)
Import media for a multicam edit
Although importing media for multicam projects is the same as importing for any other project, 
there are steps you can take during importing to help streamline the multicam workflow.Chapter 11 Advanced editing 310
Assign camera names and multicam angles
You can use the Camera Name and Camera Angle metadata tags to automate and organize your 
multicam workflow. It’s recommended (but not required) to apply these tags to your event clips 
before you create an actual multicam clip.
Create multicam clips
You create multicam clips from selected event clips (similar to the way you create auditions and 
compound clips in the Event Browser). Whether you do it manually or have Final Cut Pro do it for 
you automatically, creating a multicam clip involves three fundamental steps:
• Create angles (containing one or more clips each). 
• Arrange the order of clips within each angle.
• Synchronize the angles using a common sync point.
If you know what kind of metadata your source media has, you can create multicam clips using 
manual methods even faster than with the automatic methods. For more information, see 
Assign camera names and multicam angles on page 311 and Create multicam clips in the Event 
Browser on page 312.
Cut and switch between angles in the Angle Viewer
After you create a multicam clip, you can watch all angles simultaneously in the Angle Viewer 
while switching or cutting to different angles in real time. You can cut and switch video and 
audio at the same time or independently. For example, you can use the audio from angle 1 while 
switching the video between angles 1 to 4.
Sync and adjust angles in the Angle Editor
At any time, you can open multicam clips in the Angle Editor to adjust the synchronization and 
the angle order, or to add or delete angles. You can also use the Angle Editor to make edits to 
the individual clips inside a multicam clip (such as trimming, making color corrections, adding 
transitions, and so on). 
Edit multicam clips in the Timeline
You can switch multicam angles directly in the Timeline or the Inspector, without opening the 
Angle Viewer. Although multicam clips have some unique properties, you can edit them in the 
Timeline in the same way you edit any other clips. 
Import media for a multicam edit
When you import media for a multicam project, you can give the camcorder or file-based 
recording device a name. Final Cut Pro uses this Camera Name tag to sort the source clips within 
a multicam clip during the automatic multicam clip creation process.
If you anticipate having multicam clips with numerous angles, select “Use proxy media” in 
Playback preferences to maintain top performance during your multicam edit. You can generate 
the necessary proxy versions of your clips during the import process. 
If you have only a few angles in your multicam edit, you can make optimized versions of 
your media during import, using the Apple ProRes 422 codec. Or, if you prefer, you can select 
“Create optimized media for multicam clips” in Playback preferences to generate optimized 
media automatically every time you create a multicam clip. For more information, see Playback 
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Name your camera
The following instructions cover how to add the Camera Name property when you import media 
from a connected file-based device. You can also add the Camera Name property at a later time.
1 Connect your camera or recording device to your computer.
2 In Final Cut Pro, choose File > Import > Media (or press Command-I).
3 In the Media Import window, select your camcorder or recording device from the list of devices 
on the left, if it’s not already selected.
4 Click it again, and enter a name.
Final Cut Pro uses the name you enter as the Camera Name metadata property for all clips that 
you import from this device.
Note: Most modern camcorders and recording devices (including all iOS devices) record a 
Camera ID tag. Final Cut Pro imports the Camera ID metadata automatically when you import 
from a file-based device and can use this information to automatically build multicam angles.
Assign camera names and multicam angles
The Camera Angle and Camera Name properties are flexible metadata tags that you can use to 
organize your multicam workflow. 
Although you can assign metadata to clips at any time, it makes the most sense to assign the 
Camera Angle and Camera Name tags before you use the clips to create multicam clips. The Camera 
Angle tag can help you determine and track which clips appear in which angles. The Camera Name 
tag can be applied during import and is useful in a variety of scenarios, such as in color correction.
Final Cut Pro allows you to create multicam clips automatically or manually. If you use the 
automatic method for creating angles in the multicam clip, Final Cut Pro looks for metadata in 
the selected clips in the following order: 
• Camera Angle metadata
• Camera Name metadata
• Camera ID metadata
Note: The Camera ID tag is generated by most modern camcorders and recording devices 
(including all iOS devices). Final Cut Pro imports the Camera ID metadata automatically when 
you import from a file-based device.
Final Cut Pro uses the Camera Angle, Camera Name, and Camera ID metadata to place clips in 
the correct angle. If it doesn’t find any of this information, Final Cut Pro creates a separate angle 
for each selected clip.
Assign camera names and angles to selected clips
Do one of the following: 
m Select one or more clips in the Event Browser or the Timeline, open the Info inspector, and enter 
text in the Camera Angle field or the Camera Name field.
m In the Event Browser in list view, enter text in the Camera Angle column or the Camera Name 
column for any clip.
Note: If you use the automatic method for creating angles, Final Cut Pro uses any Camera Angle 
tags in the selected clips to name the angles in the resulting multicam clip. If no Camera Angle 
tags are present, Final Cut Pro uses Camera Name, Name (clip name), or Camera ID metadata to 
name angles. You can rename angles in the Angle Editor. For more information, see Sync and 
adjust angles and clips in the Angle Editor on page 324.Chapter 11 Advanced editing 312
Create multicam clips in the Event Browser
Creating multicam clips is similar to creating auditions and compound clips in the Event Browser. 
Multicam clips can be made up of diverse media sources (different formats, frame rates, and so 
on). You can have multiple clips in any given angle of a multicam clip.
You can have Final Cut Pro create multicam clips for you automatically, or you can create the 
clips manually.
If you know what kind of metadata your multicam media has, you can create multicam clips 
using manual methods faster than with the automatic methods. The automatic methods use 
sophisticated automatic audio sync technology to ensure synchronization accuracy (but at the 
expense of processing time). It’s best to turn off the “Use audio for synchronization” feature when 
it’s not needed. For example, if you’ve recorded accurate timecode in every clip, Final Cut Pro can 
create your multicam clip automatically without the audio sync feature.
Create a multicam clip automatically
1 In the Event Browser, select the clips you want to include in the multicam clip.
2 Do one of the following:
• Choose File > New Multicam Clip.
• Control-click the selection and choose New Multicam Clip from the shortcut menu.
3 In the window that appears, type a name for the multicam clip in the Name field.
4 If the multicam automatic settings are not shown, click Use Automatic Settings.
The multicam automatic settings appear.
Note: The automatic settings are shown by default, but if the last multicam clip you created used 
custom settings, those settings are shown.
5 To sync angles automatically using audio waveform data, select “Use audio for synchronization.” 
This option makes precision sync adjustments using audio waveforms in each angle. This is 
the same audio sync technology that you can use to automatically sync clips together into a 
compound clip. 
Sync point
Note: Some audio recordings are not suited for use with this feature. Selecting this option may 
result in long processing times during which Final Cut Pro is not available for editing.Chapter 11 Advanced editing 313
6 Click OK.
Final Cut Pro creates a new multicam clip in the event and places duplicates of the selected clips 
in the new multicam clip.
Multicam clip icon
Create a multicam clip with custom settings
1 In the Event Browser, select the clips you want to include in the multicam clip.
2 Do one of the following:
• Choose File > New Multicam Clip.
• Control-click the selection and choose New Multicam Clip from the shortcut menu.
3 In the window that appears, type a name for the multicam clip in the Name field.
4 If the multicam custom settings are not shown, click Use Custom Settings.
The custom settings appear.
Note: The automatic settings are shown by default, but if the last multicam clip you created used 
custom settings, those settings are shown.
5 In the Angle Assembly pop-up menu, choose how the angles in the multicam clip are created:
• Automatic: Final Cut Pro creates the angles automatically. 
• Camera Angle: Final Cut Pro creates angles in the multicam clip based on the Camera Angle 
property of the selected clips.
• Camera Name: Final Cut Pro creates angles in the multicam clip based on the Camera Name 
property of the selected clips.
• Clips: Final Cut Pro creates a separate angle for each selected clip, using the Name property in 
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6 In the Angle Clip Ordering pop-up menu, choose how angles are ordered within the 
multicam clip:
• Automatic: Final Cut Pro orders the clips within each angle automatically. If there is more than 
one clip per angle, Final Cut Pro inserts gap clips between the clips, as needed, to achieve the 
correct timing and spacing.
• Timecode: Final Cut Pro orders the clips within each angle using timecode recorded in the clips. 
If you recorded timecode in your clips, choose this option. It’s the fastest and most frameaccurate method of ordering clips.
• Content Created: Final Cut Pro orders the clips within each angle using the date and time 
information recorded by your camcorder or video recording device.
The Content Created method can position clips within one-second accuracy (since, in most 
camcorders, the smallest unit in date and time information is one second). If you choose this 
clip-ordering method, you will probably need to manually synchronize your angles in the 
Angle Editor to make your multicam clip frame-accurate.
Note: At any time, you can change the Content Created date and time of your source clips in 
the Event Browser. Just select one or more clips and choose Modify > Adjust Content Created 
Date and Time.
7 In the Angle Synchronization pop-up menu, choose how angles are synchronized in the 
multicam clip:
• Automatic: Final Cut Pro synchronizes the angles automatically (using one or more of the 
following methods). 
• Timecode: Final Cut Pro synchronizes the angles based on the timecode recorded in the clips. 
For more information about recording timecode, see Multicam editing workflow on page 309.
01:00:00:00
01:00:00:00 
01:00:00:00
01:00:00:00
Sync point
• Content Created: Final Cut Pro synchronizes the angles based on the date and time information 
recorded by your camcorder or video recording device.
Note: At any time, you can change the Content Created date and time of your source clips in 
the Event Browser. Just select one or more clips and choose Modify > Adjust Content Created 
Date and Time.
12:59 PM
12:59 PM
12:59 PM
12:59 PM
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• Start of First Clip: Final Cut Pro uses the first frame in each angle as the sync point. 
Sync point
Tip: The Start of First Clip method is useful if you want to use specific range selections of 
your source clips only. In the Event Browser, add keywords or the Favorite rating to the range 
selections you want to use and then filter or search for the clips. When you create your 
multicam clip, Final Cut Pro uses only the media showing in the filtered view.
• First Marker on the Angle: Final Cut Pro uses the first marker in each angle as the sync point. 
Sync point
Tip: With this method, you can use the first marker to define a region that can be fine-tuned 
with the “Use audio for synchronization” option (described below). In other words, you don’t 
need to place the marker exactly—just close enough so that the automatic audio sync feature 
can synchronize the angles the rest of the way.
8 To sync angles automatically using audio waveform data, select “Use audio for synchronization.” 
This option makes precision sync adjustments using audio waveforms in each angle. This is 
the same audio sync technology that you can use to automatically sync clips together into a 
compound clip. 
Sync point
Note: Some audio recordings are not suited for use with this feature. Selecting this option may 
result in long processing times during which Final Cut Pro is not available for editing.
9 If you want the multicam clip’s timecode to start at a value other than the earliest timecode 
value in the selected clips (the default), type a timecode value in the Starting Timecode field.
10 If you want to change the video properties settings, select Custom in the Video Properties 
section and change the settings as appropriate.
Note: By default, Final Cut Pro analyzes the selected clips and configures these settings 
according to the most common clip properties among those clips.
11 If you want to change the audio or render settings, select Custom in the Audio and Render 
Properties section and change the settings as appropriate.Chapter 11 Advanced editing 316
12 Click OK.
Final Cut Pro creates a new multicam clip in the event and places duplicates of the selected clips 
in the new multicam clip.
Multicam clip icon
Cut and switch angles in the Angle Viewer
After you create a multicam clip, you can watch all angles simultaneously in the Angle Viewer 
while switching or cutting to different angles in real time. This allows you to cut an entire 
movie as if it were live, and then fine-tune your edits in the Timeline just as you would for any 
other project.
The Angle Viewer is both a display and an interactive interface for making quick cut and switch 
decisions as you play back your multicam clips and projects. Angles appear in banks of 2, 4, 9, or 
16 angles.
Angle Viewer
Play back a multicam clip in the Angle Viewer
1 To open the Angle Viewer, do one of the following:
• Choose Window > Viewer Display > Show Angles (or press Command-Shift-7).
• Choose Show Angles from the Viewer Options pop-up menu in the top-right corner of 
the Viewer.
If you’re viewing a multicam clip in the Event Browser, you have the option to show the Event 
Viewer next to the Viewer. To show multicam angles in the Event Viewer, do one of the following:
• Choose Window > Event Viewer Display > Show Angles. 
• Choose Show Angles from the Viewer Options pop-up menu in the top-right corner of the 
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2 Use the skimmer or the playhead to play back a multicam clip in the Event Browser or 
the Timeline.
The Angle Viewer appears in the upper part of the Final Cut Pro window.
The multicam clip’s 
angles appear in the 
Angle Viewer.
Active angle
Play back a multicam 
clip in the Event Browser 
or the Timeline.
Cut and switch angles in the Angle Viewer
You can cut and switch angles “on the fly” (while playing back your project), or you can skim to 
specific points in the Timeline and then cut and switch. You can also use a combination of those 
two methods.
1 To open the Angle Viewer, choose Window > Viewer Display > Show Angles (or press 
Command-Shift-7).
2 Add the multicam clip you want to cut and switch to the Timeline. 
Note: The cut and switch feature works on Timeline clips only.
3 Do one of the following:
• Position the playhead and press the Space Bar to play back the multicam clip.
• Skim the Timeline to the frame where you want to cut and switch to a different angle.Chapter 11 Advanced editing 318
4 In the Angle Viewer, move the pointer over the angle that you want to switch to.
As you move the pointer over the angles in the Angle Viewer, the pointer changes to the Blade 
tool, indicating that a cut (and switch) will occur when you click. 
The pointer changes 
to the Blade tool.
The active angle 
is highlighted.
5 Do one of the following:
• To cut and switch: Click the angle you want to switch to. (Or press any number key to cut and 
switch to the corresponding angle of the current bank. For example, press 5 to cut and switch 
to angle 5 of the current bank.)
In the Timeline, the current multicam clip is cut at the playhead position. The section of the 
clip to the right of the playhead is replaced with a new instance of the clip, with the angle 
you clicked as the active angle. A special through edit point appears at the Timeline playhead 
position. For more information, see Edit multicam clips in the Timeline and the Inspector on 
page 330. 
• To switch: Option-click the angle you want to switch to. (Or hold down the Option key and 
press any number key to switch to the corresponding angle of the current bank. For example, 
press Option-5 to switch to angle 5 of the current bank.)
Note: The pointer changes to a pointing hand icon when you hold down the Option key, 
indicating a switch-only edit.
In the Timeline, the multicam clip under the playhead changes to show the angle you 
switched to as the active angle.
In either case, the Viewer switches to the angle you selected. The active angle is highlighted in 
yellow, blue, or green, depending on the switch mode you’re using. For more information, see 
“Switch video or audio separately,” below.Chapter 11 Advanced editing 319
Switch video or audio separately
By default, Final Cut Pro switches the video and audio of a multicam clip at the same time. But 
you can set Final Cut Pro to switch the video and audio separately. 
1 To open the Angle Viewer, choose Window > Viewer Display > Show Angles (or press 
Command-Shift-7).
2 To change the switch mode, do one of the following:
• To enable video and audio switching: Click the left switch mode button in the upper-left corner 
of the Angle Viewer. This is the default setting. 
Click to enable video 
and audio switching.
Yellow highlighting indicates 
that both the active video 
and the active audio are 
contained in one clip.
The bank switcher 
shows the active angle.
• To enable video-only switching: Click the middle switch mode button. Only the video switches. 
The audio from the original angle remains active.
Click to enable 
video-only switching.
• To enable audio-only switching: Click the right switch mode button. Only the audio switches. 
The video from the original angle remains active.
Click to enable 
audio-only switching.
3 Do one of the following:
• To cut and switch: Click an angle in the Angle Viewer. 
• To switch: Option-click an angle in the Angle Viewer. Chapter 11 Advanced editing 320
If you selected the video-only or audio-only switch mode, blue highlighting indicates the active 
video angle and green highlighting indicates the active audio angle.
Switch Video 
Only button
Switch Audio 
Only button
The active video angle 
is highlighted in blue.
The active audio angle 
is highlighted in green.
The bank switcher 
shows the active angles.
Tip: With audio-only switching enabled, you can add audio components from inactive angles 
to the active angle or remove audio components from the active angle. Simply CommandOption-click an inactive angle to add its audio to the active angle. Or Command-Option-click 
an active angle to remove its audio. For more information, see “Example: Add or remove audio 
components in a multicam clip” in Multichannel audio editing examples on page 180. 
View and navigate banks of angles
Depending on the Angle Viewer display setting you choose, you can show 2, 4, 9, or 16 angles at 
once. These sets of angles are known as banks. The bank switcher in Final Cut Pro is an efficient 
tool for displaying and navigating banks of angles in a multicam clip.
1 To open the Angle Viewer, choose Window > Viewer Display > Show Angles (or press 
Command-Shift-7).
2 Position the skimmer or the playhead over a multicam clip in the Event Browser or the Timeline.
The bank switcher appears as a grid of squares at the bottom of the Angle Viewer. Yellow, blue, or 
green highlighting indicates the currently active angle. 
The bank switcher shows 
the number of angles 
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3 In the Settings pop-up menu (in the upper-right corner of the Angle Viewer), choose the number 
of angles you want to display in each bank.
Settings pop-up menu 
in the upper-right corner 
of the Angle Viewer
If the number of angles in your multicam clip exceeds the current Angle Viewer display setting, 
Final Cut Pro creates additional banks and displays them as separate grids of squares. 
Here are a few examples of different angle bank combinations: 
• Three banks of 4 angles each, with the last angle in the third bank as the active angle, and the 
third bank as the currently displayed bank:
• One bank of 16 angles, with the last angle as the active angle:
• One bank of 9 angles and another bank of 7 angles, with the first bank as the currently 
displayed bank:
4 To navigate banks of angles, do any of the following: 
• To display a bank’s angles in the Angle Viewer: Click the bank switcher icon for the bank.
• To display the previous bank: Press Shift-Option-Semicolon (;).
• To display the next bank: Press Shift-Option-Apostrophe (’).Chapter 11 Advanced editing 322
Show overlays in the Angle Viewer
For each angle that appears in the Angle Viewer, you can display video overlays showing 
timecode and either the clip name or the angle name.
Angle name Timecode
1 To open the Angle Viewer, choose Window > Viewer Display > Show Angles (or press 
Command-Shift-7).
2 To choose a display option, do one of the following:
• To display timecode for the clips in each angle: Choose Timecode from the Settings pop-up 
menu in the upper-right corner of the Angle Viewer. (Choose Timecode again to turn off the 
timecode display.)
Settings pop-up menu 
in the upper-right corner 
of the Angle Viewer
• To display the names of the clips in each angle: In the Settings pop-up menu, choose Display 
Name > Clip.
• To display the name for each angle: In the Settings pop-up menu, choose Display Name > Angle.
• To turn off display names: In the Settings pop-up menu, choose Display Name > None. 
Adjust the Angle Viewer display
You can adjust the Angle Viewer display to suit your needs.
m To adjust the number of angles in the Angle Viewer: In the Settings pop-up menu in the upper-right 
corner of the Angle Viewer, choose either 2 Angles, 4 Angles, 9 Angles, or 16 Angles.
Angle Viewer in the 
9 Angles display setting
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m To adjust the size of the Angle Viewer and the main Viewer: Drag the boundary between them.
Drag the boundary to the right.
Drag the boundary to the left.
m To make the Angle Viewer a vertical column: Drag the boundary to the left, and drag the Final Cut 
Pro toolbar downward to expand the Viewer quadrant vertically. (This vertical column view is 
available only in the 2 Angles and 4 Angles views.)
Drag the boundary to the left. Drag the toolbar down.Chapter 11 Advanced editing 324
Sync and adjust angles and clips in the Angle Editor
At any time, you can open multicam clips in the Angle Editor to adjust the synchronization and 
the angle order, set the monitoring angle, or add or delete angles. 
Note: When you open any multicam clip in the Angle Editor (whether from the Event Browser 
or the Timeline) you are actually opening the parent multicam clip. Any changes you make in 
the Angle Editor are propagated to all child clips of that multicam clip, in every project. For more 
information, see Create multicam clips in the Event Browser on page 312. 
You can use the Angle Editor to edit the individual clips inside a multicam clip (similar to 
how you can edit the contents of a compound clip). The many changes you can make in the 
Angle Editor include basic edits and trimming as well as effects you would normally add in the 
Timeline, such as color corrections and transitions. 
You can copy and paste clips in the Angle Editor. Clips are pasted sequentially as overwrite edits, 
and in the monitoring angle only.
Tip: Before you edit multicam clips in the Angle Editor, duplicate them in the Event Browser to 
maintain clean backup copies.
You cannot cut and switch between angles in the Angle Editor. You also cannot connect clips, 
solo clips, use the Precision Editor, perform ripple deletes, or use the Detach Audio and Break 
Apart Clip Items commands.
Open a multicam clip in the Angle Editor
Do one of the following:
m Double-click a multicam clip in the Event Browser.
m Control-click a multicam clip in the Event Browser or the Timeline, and choose Open in Angle 
Editor from the shortcut menu.
The Angle Editor opens in the Timeline area at the bottom of the Final Cut Pro window. Although 
similar to the Timeline, the Angle Editor provides a separate interface dedicated to editing angles 
and clips inside multicam clips. Each angle in the multicam clip appears as a separate row in the 
Angle Editor. 
The Angle Editor appears 
in the Timeline area.Chapter 11 Advanced editing 325
Set video and audio monitoring in the Angle Editor
In the Angle Editor, you can set any one angle to be the monitoring angle. This is the angle 
you see in the Viewer when the multicam clip is playing back in the Angle Editor. You can also 
monitor the audio of any number of angles at once.
You use the monitoring angle to synchronize angles in the Angle Editor. The monitoring angle 
is not the same thing as the active angle (which you see in the Timeline). You cannot cut and 
switch between angles in the Angle Editor.
Note: Setting the correct monitoring angle is important for the two synchronization commands 
described later in this section: Sync to Monitoring Angle and Sync Angle to Monitoring Angle.
1 To open the Angle Editor, do one of the following:
• Double-click a multicam clip in the Event Browser.
• Control-click a multicam clip in the Event Browser or the Timeline and choose Open in Angle 
Editor from the shortcut menu.
2 To set an angle as the monitoring angle, do any of the following:
• Click the Video Monitor icon at the left side of the angle.
• Choose Set Monitoring Angle from the pop-up menu next to the angle name.
• Press Shift-V while skimming the angle.
The Video Monitor icon turns white, and the entire angle is highlighted in light gray. The angle 
plays in the Viewer when you play back the multicam clip in the Angle Editor. Only one angle can 
be the video monitoring angle at a time.
Click to set the monitoring angle.Chapter 11 Advanced editing 326
3 To turn on audio monitoring for an angle, do one of the following:
• Click the Audio Monitor icon once. (To turn off audio monitoring, click the icon again.)
• Choose Monitor Audio from the pop-up menu next to the angle name. (To turn off audio 
monitoring, choose Monitor Audio again.)
• Press Shift-A while skimming the angle. (To turn off audio monitoring, press Shift-A again.)
Audio monitoring on
Audio monitoring off
The monitoring settings do not affect any of your active angles. They simply change what is 
playing back in the Viewer while you’re working in the Angle Editor.
Tip: You can use audio monitoring to double-check the synchronization of individual angles 
in a multicam clip. Open the clip in the Angle Editor, and turn on audio monitoring for two or 
more angles at a time. You will hear immediately if the angles are in sync or if you need to adjust 
them further. 
Manually adjust the synchronization of a multicam clip
A primary function of the Angle Editor is to provide an easy way to correct out-of-sync angles in 
your multicam clips. The instructions below describe how to synchronize angles by locating sync 
points and then manually dragging them into alignment.
1 To open the Angle Editor, do one of the following:
• Double-click a multicam clip in the Event Browser.
• Control-click a multicam clip in the Event Browser or the Timeline and choose Open in Angle 
Editor from the shortcut menu.
2 Locate a sync point in one of the out-of-sync angles by skimming the angle in the Angle Editor.
As you skim, the angle is displayed in the left side of the Viewer (in place of the Angle Viewer). 
The sync points could be video or audio cues (such as a clapboard closing or a door slam).
3 Locate the corresponding sync point in one or more angles that you want to synchronize to the 
original angle.
To simplify this process, you can add markers at the sync points, to guide you visually and to 
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4 Drag the clips left or right in the rows of the Angle Editor so that the sync points align vertically.
Sync point
Sync point
Drag the clip to align 
the sync points.
If an angle contains more than one clip, you can easily select all clips in the angle so that you can 
move them all at once. To do this, choose Select Clips in Angle from the pop-up menu next to 
the angle name.
To select all clips in an angle, 
choose Select Clips in Angle 
from the pop-up menu.Chapter 11 Advanced editing 328
You can then drag the clips left or right to move them all by the same amount.
When all clips in the angle 
are selected, you can drag 
them all at once.
Automatically adjust the synchronization of a multicam clip
The instructions below describe two automatic methods for synchronizing angles in a 
multicam clip.
1 To open the Angle Editor, do one of the following:
• Double-click a multicam clip in the Event Browser.
• Control-click a multicam clip in the Event Browser or the Timeline and choose Open in Angle 
Editor from the shortcut menu.
2 In the out-of-sync angle, click the pop-up menu to the right of the angle name and choose one 
of the following: 
• Sync to Monitoring Angle: This option opens a two-up display in the Viewer, showing the frame 
at the skimmer position on the left and the frame at the playhead position of the monitoring 
angle on the right. In the out-of-sync angle, skim to a frame and click to sync the angle to the 
playhead position. All the clips in the angle move together to align the frame you clicked with 
the playhead. To close the two-up display in the Viewer, click Done.
• Sync Angle to Monitoring Angle: This option compares the audio waveforms in the selected 
angle to the waveforms in the monitoring angle, and then moves the clips in the selected 
angle to synchronize them with those in the monitoring angle. This is the same audio 
sync technology that you can use to automatically analyze and sync clips together into a 
compound clip. 
If you select clips in one or more angles before choosing this option, the command name 
in the pop-up menu changes to Sync Selection to Monitoring Angle. When you choose this 
option, Final Cut Pro moves all of the selected clips to synchronize them with those in the 
monitoring angle. If there is a selection in the monitoring angle, this option is not available.
WARNING: This option does not ripple clips forward. If clips are moved to a Timeline location 
that is already occupied by existing clips, the moved clips overwrite the existing clips.
Note: Some audio recordings are not suited for use with this feature. Choosing this option 
may result in long processing times during which Final Cut Pro is not available for editing.Chapter 11 Advanced editing 329
Adjust the order of angles in a multicam clip
You can adjust the order in which angles appear in the Angle Viewer and the Angle Editor.
Note: If you’ve already started a multicam edit on a multicam clip in the Timeline, changing the 
angle order does not affect which angle is chosen for each cut and switch edit.
1 To open the Angle Editor, do one of the following:
• Double-click a multicam clip in the Event Browser.
• Control-click a multicam clip in the Event Browser or the Timeline and choose Open in Angle 
Editor from the shortcut menu.
2 At the right side of the Angle Editor, use the drag handles to drag the angle rows up or down to 
reorder them.
Use the drag handles 
to reorder the angles.
The angles in the Angle Editor and the Angle Viewer change to the new order.
Add, delete, or rename angles in a multicam clip
1 To open the Angle Editor, do one of the following:
• Double-click a multicam clip in the Event Browser.
• Control-click a multicam clip in the Event Browser or the Timeline and choose Open in Angle 
Editor from the shortcut menu.
2 Do any of the following:
• To delete an angle: Choose Delete Angle from the pop-up menu to the right of the angle name.
The angle is removed from the Angle Editor, the Angle Viewer, and all child clips of the 
multicam clip.
Important: Deleting an active angle affects the edits in your projects. The deleted angle is 
replaced with black filler in all projects.
• To add an angle: Choose Add Angle from the pop-up menu to the right of the angle name.
A new, empty angle appears in the Angle Editor and the Angle Viewer.
• To rename an angle: At the left side of the Angle Editor, click the name of the angle you want 
to rename. When the text becomes highlighted, type the new name.
The new name appears in the Angle Editor and (if overlays are turned on) in the Angle Viewer.Chapter 11 Advanced editing 330
Edit multicam clips in the Timeline and the Inspector
You can switch multicam clip angles directly in the Timeline or the Info Inspector, without having 
to open the Angle Viewer.
Multicam clips generally function in the Timeline like any standard clips. You can add video and 
audio effects, transitions, and markers; attach connected clips; and apply retiming effects. You can 
apply split edits to multicam clips and edit them in the Precision Editor. You can nest multicam 
clips in compound clips and storylines.
However, multicam clips do have some unique characteristics in the Timeline:
• You can display the names of the active video angle and the active audio angle in the 
multicam clip in the Timeline.
• Cut and switch edit points appear as dotted lines in the Timeline. These are through edits (in 
which the video or audio content on either side of the edit point is continuous). In the case 
of multicam editing, through edits indicate that the content on either side of the edit point 
comes from the same multicam clip. A black dotted line indicates that different angles from 
the same multicam clip are on either side of the edit point. 
Before the cut, 
the angle is “car left.”
Standard edit point
After the cut, 
the angle is “car right.”
A through edit point appears 
at the playhead position.Chapter 11 Advanced editing 331
In the case of video-only or audio-only cuts and switches, the edit point can be mixed (with 
both black and white dotted lines). For example, when you cut and switch video only, you see 
a black dotted line for the video and a white dotted line for the audio. 
Black dotted lines indicate that different 
angles from the same multicam clip are 
on either side of the edit point.
A white dotted line indicates 
that the same angle is on 
either side of the edit point.
• When you move the pointer over a multicam through edit, the pointer changes to the Trim 
tool, indicating that the edit will be a roll edit (because any other type of edit breaks the 
relationship between the clips on either side of the cut and switch edit point in the Timeline).
• Many edits (such as split edits, markers, connected clips, and retiming effects) remain in 
place on a multicam clip in the Timeline even after you switch the angle. But certain editing 
operations are associated directly with the specific angle and are not retained when you 
switch angles: 
• Video and audio effects
• Keyframing (including audio volume and panning)
• Role assignments
Switch angles in the Timeline 
1 In the Timeline, Control-click the multicam clip you want to switch.
2 Do one of the following: 
• To switch the video angle: Choose Active Video Angle from the shortcut menu, and choose the 
angle you want to switch to from the submenu.
• To switch the audio angle: Choose Active Audio Angle from the shortcut menu, and choose the 
angle you want to switch to from the submenu.
The clip switches to the video or audio angle you chose.Chapter 11 Advanced editing 332
Switch angles in the Inspector
Switching angles in the Inspector allows you to switch angles for multiple selected multicam 
clips at once.
1 Select one or more multicam clips that you want to switch.
2 Open the Info inspector.
3 In the Info inspector, do one of the following:
• To switch the video angle: In the Active Video Angle pop-up menu, choose the angle you want 
to switch to.
• To switch the audio angle: In the Active Audio Angle pop-up menu, choose the angle you want 
to switch to.
 Display the names of the active video and audio angles in the Timeline
You can have Final Cut Pro display the names of the active video angle and the active audio 
angle in the multicam clip in the Timeline, in the following format: V: video angle name | A: audio 
angle name.
Active video angle
Active audio angle
m Click the Clip Appearance button in the lower-right corner of the Timeline and choose Clip 
Names or Angles from the Show pop-up menu.
Multicam editing tips and tricks
The following tips can help you streamline your multicam workflow:
• Set the date, the time, and the time zone on your camcorder or recording device before you 
shoot footage for your multicam project. This provides useful information to Final Cut Pro 
during the automatic multicam clip creation process.
Note: At any time, you can change the Content Created date and time of your source clips in 
the Event Browser. Just select one or more clips and choose Modify > Adjust Content Created 
Date and Time.
• Because you can use the sophisticated automatic audio sync feature in Final Cut Pro to help 
ensure multicam synchronization accuracy, it makes sense to record audio on every camcorder 
and recording device in your multicam production. (Clear audio recordings provide the 
best results.)
• Before you edit multicam clips in the Angle Editor, duplicate them in the Event Browser to 
maintain clean backup copies.
• To double-check the synchronization of individual angles in a multicam clip, open the clip in 
the Angle Editor and turn on audio monitoring for two or more angles at a time. You will hear 
immediately if the angles are in sync or if you need to adjust them further.Chapter 11 Advanced editing 333
• If performance becomes an issue while you’re working on a multicam project, do any of 
the following: 
• Set Final Cut Pro to use proxy playback by selecting “Use proxy media” in Playback 
preferences. Proxy playback allows you to play back more angles at a time. To use proxy 
playback, you must have proxy versions of your media available, or you must create proxy 
versions. For more information about creating proxy versions, see Transcode media files on 
page 397.
• Make sure that “Create optimized media for multicam clips” is selected in Playback 
preferences. For more information, see Playback preferences on page 419. This option 
transcodes video to the Apple ProRes 422 codec format, which provides better performance 
during multicam editing. This option is turned on by default. If the original camera format 
can be edited with good performance, you can deselect this checkbox.
• Make sure that the hard disk holding your multicam source clips is fast enough to play back 
all of your media at once. You can check hard disk performance by choosing Final Cut Pro > 
Preferences and selecting “Warn when frames are dropped due to hard disk performance.” 
To find out if something else is causing playback issues, select “Warn when dropping frames 
during playback.” 
• You can use photos (from a still camera) in a multicam clip. If the date and time (Content 
Created) information matches the contents of the other angles, the photos are automatically 
adjusted in duration to “fill in” the angle.334
Keying
Keying overview
There are times when you need to combine two clips to create an image with bits of both. A 
common way to combine two clips is to use a keying process, where the video of the top, or 
foreground, clip is processed to eliminate either a color or luma value in areas of the video and 
then is combined with the bottom, or background, clip.
For example, keying allows you to take a video clip of a person standing in front of a green 
background and replace that green with a street scene, making it appear as though that person 
is standing on the street.
This type of keying is accomplished using one of two keyer effects in Final Cut Pro:
• Keyer: This general purpose chroma-keying effect is optimized for blue- or green-screen keying 
but can key any range of color you choose. See Use chroma keys on page 334.
• Luma Keyer: This is designed to generate mattes based on the image’s lightness—you choose 
to remove the white or black areas and whether or not the gray areas should be partially 
transparent. See Use luma keys on page 343.
In addition to these keying effects, you may need to use a matte, a positioning effect, and color 
correction to ensure the foreground video looks natural when keyed over the background. For 
more information, see Finalize the key on page 348.
Another way to combine two clips is for the foreground clip to have an alpha or matte 
channel that defines which parts of the foreground clip to keep and which to replace with the 
background clip. This is common when working with computer-generated logos or animated 
graphics. For more information, see Compositing overview on page 351.
Use chroma keys
A challenging part of creating a good chroma key is shooting the chroma key video, and in 
particular, using a good, well-lit background that provides a uniform color to remove. A wide 
variety of specialized chroma key background options are available, from chroma key paint 
that includes highly reflective additives to chroma key cloth or paper sheets. Additionally, it is 
important to use the best camera you can access and avoid using a highly compressed video 
format such as DV or MPEG-2.
Keying and compositing 12Chapter 12 Keying and compositing 335
For the following examples, this woman will be keyed over a street scene. The light stands will be 
handled in Finalize the key on page 348.
Apply the chroma key effect
1 In the Timeline, add the foreground clip (the chroma key clip with the color you want to remove) 
to the primary storyline.
2 Drag the background clip (the clip you want to superimpose the chroma key clip over) so that it 
is connected below the foreground clip in the primary storyline.
Foreground
Background 
attached as a 
connected clip
For more information about connected clips, see Connect clips to add cutaway shots, titles, and 
synchronized sound effects on page 103.
3 Select the foreground clip in the Timeline, and click the Effects button in the toolbar.
Tip: For best results, also position the playhead at a point within the foreground clip that shows 
the maximum amount of the color to be keyed.
4 In the Effects Browser, select the Keyer effect.
Tip: Type “keyer” in the Effects Browser’s search field to quickly find the Keyer effect.Chapter 12 Keying and compositing 336
5 Do one of the following:
• Drag the effect to the Timeline foreground clip to which you want to apply it.
• Double-click the effect thumbnail to apply it to the selected clip.
The Keyer effect automatically analyzes the video to detect a green or blue dominant color 
and configures itself to remove that color. If the resulting key is not right or you would like to 
improve it, you can adjust the chroma key effect.
Adjust the chroma key effect
The following steps assume you have applied the chroma key effect.
1 In the Timeline, select the foreground clip with the Keyer effect, and open the Video inspector.
Controls for modifying and improving the Keyer effect appear.
2 If the Select tool is not the active tool, choose it from the Tools pop-up menu in the toolbar (or 
press A).
3 To improve the key using controls in the Viewer, use the Refine Key and Strength controls to do 
any of the following:
• To identify areas of the foreground clip that might still have some of the chroma key color showing: 
Click the Sample Color thumbnail image in the Video inspector and draw a rectangle in the 
Viewer over the area where the chroma key color needs to be removed.
Note: By default, the Keyer effect applies spill removal, which causes any leftover fringing of 
the blue- or green-screen background color you’re making transparent to appear as gray. To 
see the original color, set the Spill Level parameter to 0%.
Drag over an area where 
the chroma key color 
is not being removed.Chapter 12 Keying and compositing 337
To improve the key, you can drag the rectangle to adjust its position or drag its corners to 
change its size, and you can drag additional rectangles over any areas with the chroma key 
color still showing.
Tip: Select Matte (the center button) in the View area in the Video inspector to see the matte 
that the chroma keyer is creating. This can make it much easier to see areas that are not 
keying well.
• To refine any difficult areas, such as hair and reflections: Click the Edges thumbnail image in 
the Video inspector, draw a line across the difficult area in the Viewer (with one end in the 
area to keep and the other in the area to remove), and drag the line’s handle to adjust the 
edge softness.
Drag to set the edge softness.
You can use the following keyboard shortcuts to work directly in the Viewer:
• To make a Sample Color adjustment: Draw a rectangle while holding down the Shift key.
• To make an Edges adjustment: Draw a line while holding down the Command key.
• To delete a Sample Color or Edges adjustment: Click a Sample Color rectangle or Edges line 
while holding down the Option key, or select the control and press the Delete key.
• To choose a different color if the Keyer effect chose the wrong color: Set the Strength parameter 
to 0 (to override the automatic initial color sampling). Then use Sample Color to choose the 
color to remove. Select Composite (the left button) in the View area to see the foreground clip 
combined with the background clip.
• To adjust how strongly the Keyer matches a color in the foreground image to the default chroma 
key color: Use the Strength slider to adjust the tolerance (core transparency) of the Keyer 
effect’s automatic sampling. The default value is 100%. Reducing this value narrows the range 
of color sampled, resulting in less transparency in the keyed image. Increasing the Strength 
value expands the range of color sampled, resulting in more transparency in the keyed image. 
The Strength parameter is useful to retrieve areas of semitransparent detail such as hair, 
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4 To help fine-tune the key, use the View options:
Original 
(unprocessed 
foreground)
Matte (foreground-based 
alpha signal created 
by the keyer)
The name of the currently 
selected View button
Composite 
(foreground combined 
with background)
• Composite: Shows the final composited image, with the keyed foreground subject over the 
background clip. This is the default view.
• Matte: Shows the grayscale matte, or alpha channel, that’s being generated by the keying 
operation. White areas are solid (the foreground video is opaque), black areas are transparent 
(the foreground is not seen at all), and varying shades of gray indicate varying levels 
of transparency (the background video can be seen mixed with the foreground video). 
Viewing the matte makes it easier to spot unwanted holes in the key or areas that aren’t 
transparent enough.
• Original: Shows the original, unkeyed foreground image.
5 To further refine the matte, use the following controls:
• Fill Holes: Increasing this parameter value adds solidity to regions of marginal transparency 
within a key. This control is useful when you’re satisfied with the edges of your key, but you 
have unwanted holes in the interior that you can’t eliminate via the Strength parameter 
without ruining your edges.
• Edge Distance: Lets you adjust how close to the edge of your keyed subject the effect of the Fill 
Holes parameter gets. Reducing this parameter value brings the filled area of the matte closer 
to the edge of the subject, sacrificing translucency at the edges. Raising this parameter value 
pushes the filled area of the matte farther from the edge. Too much edge distance can result 
in unwanted translucency within parts of the subject that should be solid.
6 To suppress any of the background color that is appearing (spilling) on the foreground image, 
adjust the Spill Level control.
7 To reverse the keying operation, retaining the background color and removing the foreground 
image, select Invert.
8 To mix the keyed effect with the unkeyed effect, adjust the Mix control.
For information about making advanced chroma key adjustments, see the following instructions.Chapter 12 Keying and compositing 339
Make advanced chroma key adjustments
The following controls are available for use in difficult keying situations or for fine-tuning 
specific problems:
• Color Selection: These controls are meant to be used after you begin creating a key using 
automatic sampling or the Sample Color and Edges tools. (However, you can skip those tools 
and create a key using Manual mode, described below.) The graphical Chroma and Luma 
controls provide a detailed way of refining the range of hue, saturation, and image lightness 
that define the keyed matte.
• Matte Tools: These controls are for refining the transparency matte generated by the previous 
sets of parameters. These parameters don’t alter the range of values sampled to create the 
keyed matte. Instead, they alter the matte generated by the Keyer effect’s basic and advanced 
controls, letting you shrink, expand, soften, or invert the matte to achieve a better composite.
• Light Wrap: These controls are for blending color and lightness values from the background 
layer of your composite with the keyed foreground layer. Using these controls, you can 
simulate the interaction of environmental lighting with the keyed subject, making it appear as 
if background light wraps around the edges of a subject.
The following steps assume you have applied the chroma key effect.
1 In the Timeline, select the foreground clip with the Keyer effect, and open the Video inspector.
Controls for modifying and improving the Keyer effect appear.
2 Click Color Selection to reveal the following controls: 
• Graph: Provides two options to set how the adjustable graphs in the Chroma and Luma 
controls are used to fine-tune a key:
• Scrub Boxes: Select to limit the Chroma and Luma controls to adjusting softness (edge 
transparency) in the matte you are creating. In this mode, you cannot manually adjust 
tolerance (core transparency), which is determined by the Keyer effect’s automatic sampling, 
plus any Sample Color rectangles you’ve added in the Viewer. To increase matte tolerance, 
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• Manual: Select to use the Chroma and Luma controls to adjust the softness (edge 
transparency) and tolerance (core transparency) in the matte you are creating. Make sure the 
Strength slider is set to a value greater than 0 before you switch to Manual mode; otherwise 
the Chroma and Luma controls are disabled. When you switch to Manual mode, the Refine 
Key tools and Strength slider become disabled, but samples you’ve made with those 
controls continue to contribute to the matte.
Important: When you switch to Manual mode, it’s best not to switch back to Scrub Boxes 
mode. For best results, begin keying an image using the Sample Color and Edges tools in 
Scrub Boxes mode. Switch to Manual mode afterward if you feel it’s necessary to refine your 
matte using the Chroma and Luma controls. However, if you switch back to Scrub Boxes mode, 
you may experience unexpected combinations of additionally sampled and keyframed values 
that might be difficult to control.
• Chroma: Drag the two graphs in this color wheel control to adjust the isolated range of hue 
and saturation that help define the keyed matte. The selected mode governs which graphs 
in the color wheel are adjustable. The outer graph controls the softness (edge transparency) 
of the matte you’re creating, and can be adjusted in either Scrub Boxes or Manual mode. The 
inner graph controls tolerance (core transparency), and is only adjustable when in Manual 
mode. Drag any side of either graph to expand or contract the graph’s border, which adds to 
or subtracts from the range of hue and saturation contributing to the key. In Manual mode, 
you can also drag inside the tolerance graph to adjust its overall position in the color wheel. 
To the left of the color wheel, a small graph displays the slope of chroma rolloff, the relative 
softness of matte edges in regions most affected by the Chroma control. Dragging the Chroma 
Rolloff slider (described below) modifies the shape of this slope.
Tip: It’s possible to zoom in to and pan around the Chroma control to more precisely adjust 
the graphs. To zoom in to the Chroma control, move the pointer over the color wheel, and, 
holding down the Z key, drag to the left to zoom out or to the right to zoom in. To pan in the 
Chroma control, hold down the H key and drag in the color wheel in the direction you want 
to move it. To reset the zoom and recenter the Chroma control, move the pointer over the 
Chroma control and press Shift-Z.
• Luma: Drag the adjustable handles in this grayscale gradient to modify the isolated range 
of the luma channel (the range of lightness and darkness) that also helps define the keyed 
matte. The upper handles (which appear only in Manual mode) adjust the tolerance (core 
transparency) of the luma channel’s contribution to the key. The lower handles adjust the 
softness (edge transparency) of the luma channel’s contribution to the key. The Graph mode 
governs which handles are adjustable. In Scrub Boxes mode, you can adjust only the lower 
softness handles, which modify the range of lightness and darkness affecting the edge 
transparency of the matte. In Manual mode, you can also adjust the upper tolerance handles, 
which modify core transparency within the luma channel of the matte. By default, the slope of 
the left and right sides of the Luma graph has a slight “S” curve. You can modify the shape of 
the curve by adjusting the Luma Rolloff slider (described below).
Note: The luma softness handles may extend past the outer boundaries of the Luma control. 
This is due to the floating-point precision of the Keyer effect and is expected behavior. To 
reveal and move out-of-bounds handles, drag the slope line of the Luma graph.
• Chroma Rolloff: Use this slider to adjust the linearity of the chroma rolloff slope (displayed 
in the small graph to the left of the Chroma control). Chroma rolloff modifies the softness 
of the matte around the edges of regions that are affected most by the Chroma control. 
Lowering this value makes the slope of the graph more linear, which softens the edges of the 
matte. Raising this value makes the slope of the graph steeper, which sharpens the edges of 
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• Luma Rolloff: Use this slider to adjust the linearity of the luma rolloff slope (the ends of the 
bell-shaped luma curve displayed in the Luma control). Luma rolloff modifies the softness of 
the matte around the edges of regions that are affected most by the Luma control. Lowering 
this value makes the slope between the upper and lower handles in the Luma control more 
linear, which increases edge softness in the matte. Raising this value makes the slope steeper, 
sharpening the edges of the matte and making them more abrupt.
• Fix Video: Select this checkbox to apply subpixel smoothing to the chroma components of the 
image, reducing the jagged edges that result from keying compressed media using 4:2:0, 4:1:1, 
or 4:2:2 chroma subsampling. Although selected by default, this checkbox can be deselected if 
subpixel smoothing degrades the quality of your keys.
3 Click Matte Tools to reveal the following controls:
• Levels: Use this grayscale gradient to alter the contrast of the keyed matte, by dragging three 
handles that set the black point, white point, and bias (distribution of gray values between the 
black point and white point). Adjusting the contrast of a matte can be useful for manipulating 
translucent areas of the key to make them more solid (by lowering the white point) or more 
translucent (by raising the black point). Dragging the Bias handle right erodes translucent 
regions of the key, while dragging the Bias handle left makes translucent regions of the key 
more solid.
• Black, White, Bias: Click the disclosure triangle in the Levels row to reveal sliders for the Black, 
White, and Bias parameters. These sliders, which mirror the settings of the Levels handles 
described above, allow you to keyframe the three Levels parameters (via the Add Keyframe 
button to the right of each slider). Keyframing the Black, White, and Bias parameters may yield 
a better key, one that adapts to changing blue-screen or green-screen conditions.
• Shrink/Expand: Use this slider to manipulate the contrast of the matte to affect matte 
translucence and matte size simultaneously. Drag the slider left to make translucent regions 
more translucent while simultaneously shrinking the matte. Drag the slider right to make 
translucent regions more solid while simultaneously expanding the matte.
• Soften: Use this slider to blur the keyed matte, feathering the edges by a uniform amount.
• Erode: Drag this slider right to gradually increase transparency from the edge of the solid 
portion of the key inward.
4 Click Spill Suppression to reveal the following controls:Chapter 12 Keying and compositing 342
• Spill Contrast: Use this grayscale gradient to adjust the contrast of the color being suppressed, 
using Black and White point handles (and corresponding sliders). Modifying spill contrast can 
reduce the gray fringing surrounding a foreground subject. The Black point handle (on the left 
side of the gradient control) lightens edge fringing that is too dark for a successful composite. 
The White point handle (on the right side of the gradient control) darkens edge fringing that 
is too light. Depending on how much spill is neutralized by the Spill Level slider, these controls 
may have a greater or lesser effect on the subject.
• Black, White: Click the disclosure triangle in the Spill Contrast row to reveal sliders for the Black 
and White point parameters. These sliders, which mirror the settings of the Spill Contrast 
handles described above, allow you to keyframe the Black point and White point parameters 
(via the Add Keyframe button to the right of each slider).
• Tint: Use this slider to restore the natural color of the keyed foreground subject. Because the 
Spill Suppression controls eliminate blue or green spill by desaturating subtle blue or green 
fringing and reflection on the subject, the Tint slider lets you add hues to restore the natural 
color of the subject. Overdoing this parameter results in over-tinting the subject with the 
complementary color of the hue being suppressed—magenta if green, and orange if blue.
• Saturation: Use this slider to alter the range of hues introduced by the Tint slider (when the 
Tint slider is used at moderate levels).
5 Click Light Wrap to reveal the following controls:
• Amount: Use this slider to control the overall light wrap effect, setting how far into the 
foreground the light wrap extends.
• Intensity: Use this slider to adjust gamma levels to lighten or darken the interaction of wrapped 
edge values with the keyed foreground subject.
• Opacity: Use this slider to fade the light wrap effect up or down.
• Mode: Use this pop-up menu to choose the compositing method that blends the sampled 
background values with the edges of the keyed subject. There are five modes:
• Normal: Evenly blends light and dark values from the background layer with the edges of the 
keyed foreground layer.
• Lighten: Compares overlapping pixels from the foreground and background layers, and then 
preserves the lighter of the two. Good for creating a selective light wrap effect.
• Screen: Superimposes lighter portions of the background layer over wrapped areas of the 
keyed foreground layer. Good for creating an aggressive light wrap effect.
• Overlay: Combines the background layer with the wrapped areas of the keyed foreground 
layer so overlapping dark portions become darker, light portions become lighter, and colors 
become intensified.
• Hard Light: Similar to the Overlay composite mode, except that colors become muted.Chapter 12 Keying and compositing 343
Animate the chroma key effect
To compensate for changing conditions in the foreground clip, you can make Sample Color and 
Edges adjustments at multiple points in the clip.
The following steps assume you have applied the chroma key effect.
1 Place the Timeline’s playhead at the start of the clip.
2 Use Sample Color and Edges (described above) to create a good chroma key.
3 Move the Timeline’s playhead to a point later in the clip where the lighting or background 
conditions change, resulting in the chroma key no longer being acceptable.
4 Use Sample Color and Edges to once again create a good chroma key.
5 To add additional adjustments at other playhead positions, repeat steps 3 and 4 as needed.
6 To move the playhead between each adjustment point you add, use the Jump to Sample arrows.
When you play the clip, the Sample Color and Edges settings smoothly change from one sample 
point to the next. For even greater control, you can add keyframes for most of the other settings 
in the Keyer section of the Video inspector. For more information about working with keyframes, 
see Video animation overview on page 247.
Note: Keyframes for the chroma and luma graphs in the Color Selection controls appear only in 
the Video inspector and not the Video Animation Editor in the Timeline.
Use luma keys
Luma keys provide a way to composite a foreground clip over a background clip based on the 
luminance levels in the video. This is most often useful for still images, such as a picture of a logo 
over a black background, or computer-generated graphics.
For the following examples, this speedometer image will be keyed over an outdoor car scene, 
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Apply the luma key effect
1 In the Timeline, move the playhead to the point in the background clip (the clip you want to 
superimpose the luma key clip over) where you want the key to start.
2 In the Event Browser, select the part of the foreground clip (the luma key clip with the black or 
white you want to remove) you want to key over the background, and choose Edit > Connect to 
Primary Storyline (or press Q).
Foreground clip
Background clip
For details about connecting clips in this way, see Connect clips to add cutaway shots, titles, and 
synchronized sound effects on page 103.
3 Select the foreground clip in the Timeline and click the Effects button in the toolbar.
4 In the Effects Browser, select the Luma Keyer effect.
Tip: Type “keyer” in the Effects Browser’s search field to quickly find the Luma Keyer effect.
5 Do one of the following:
• Drag the effect to the Timeline foreground clip to which you want to apply it.
• Double-click the effect thumbnail to apply it to the selected clip.
The Luma Keyer effect automatically configures itself to remove black video. If the resulting key is 
not right or you would like to improve it, you can adjust the luma key effect.Chapter 12 Keying and compositing 345
Adjust the luma key effect
The following steps assume you have applied the Luma Keyer effect.
1 In the Timeline, select the clip with the Luma Keyer effect.
2 Open the Video inspector.
The Effects section of the Video inspector shows the parameters available for adjusting the Luma 
Keyer effect.
3 To reverse the key and remove white instead of black areas of the foreground clip, select Invert.
4 To adjust the white and black clip values, drag the handles at either end of the gradient 
thumbnail image.
By default, these handles are set to provide a linear key where the luma level linearly controls the 
transparency of the foreground—100% white is fully opaque, 0% black is completely transparent, 
and 25% gray retains 25% of the foreground image. Dragging the white and black controls 
changes the values that result in fully opaque or fully transparent foreground video.
5 To adjust the softness of the edges, adjust the Luma Rolloff control.
Higher values make the edges harder, removing any partial transparency, while lower values take 
advantage of any anti-aliasing or softness the edges might have.
6 To help fine-tune the key, use the View options:
Original 
(unprocessed 
foreground)
Matte (foreground-based 
alpha signal created 
by the keyer)
Composite 
(foreground combined 
with background)
The name of the 
currently selected 
View button
• Composite: Shows the final composited image, with the keyed foreground subject over the 
background clip. This is the default view.
• Matte: Shows the grayscale matte, or alpha channel, that’s being generated by the keying 
operation. White areas are solid, black areas are transparent, and varying shades of gray 
indicate varying levels of transparency. Viewing the alpha channel makes it easier to spot 
unwanted holes in the key or areas that aren’t transparent enough.
• Original: Shows the original, unkeyed image.Chapter 12 Keying and compositing 346
7 To leave smoothly aliased text or graphics in the image visually intact, which can improve the 
edges, select Preserve RGB.
8 To mix the keyed effect with the unkeyed effect, adjust the Mix control.
For information about making advanced luma key adjustments, see the following instructions.
Make advanced luma key adjustments
The following controls are available for use in difficult keying situations or for fine-tuning 
specific problems:
• Matte Tools: These controls are for refining the transparency matte generated by the previous 
sets of parameters. These parameters don’t alter the range of values sampled to create the 
keyed matte. Instead, they alter the matte generated by the Keyer effect’s basic and advanced 
controls, letting you shrink, expand, soften, or invert the matte to achieve a better composite.
• Light Wrap: These controls are for blending color and lightness values from the background 
layer of your composite with the keyed foreground layer. Using these controls, you can 
simulate the interaction of environmental lighting with the keyed subject, making it appear as 
if background light wraps around the edges of a subject.
The following steps assume you have applied the luma key effect.
1 In the Timeline, select the clip with the Luma Keyer effect.
2 Open the Video inspector.
The Effects section of the Video inspector shows the parameters available for adjusting the Luma 
Keyer effect.
3 Click Matte Tools to reveal the following controls:Chapter 12 Keying and compositing 347
• Fill Holes: Increasing this parameter value adds solidity to regions of marginal transparency 
within a key. This control is useful when you’re satisfied with the edges of your key, but you 
have unwanted holes in the interior that you can’t eliminate via the Luma Rolloff parameter 
without ruining your edges.
• Edge Distance: Lets you adjust how close to the edge of your keyed subject the effect of the Fill 
Holes parameter gets. Reducing this parameter value brings the filled area of the matte closer 
to the edge of the subject, sacrificing translucency at the edges. Raising this parameter value 
pushes the filled area of the matte farther from the edge, potentially introducing regions of 
unwanted translucency within parts of the subject that should be solid.
• Levels: Use this grayscale gradient to alter the contrast of the keyed matte, by dragging three 
handles that set the black point, white point, and bias (distribution of gray values between the 
black point and white point). Adjusting the contrast of a matte can be useful for manipulating 
translucent areas of the key to make them more solid (by lowering the white point) or more 
translucent (by raising the black point). Dragging the Bias handle right erodes translucent 
regions of the key, while dragging the Bias handle left makes translucent regions of the key 
more solid.
• Black, White, Bias: Click the disclosure triangle in the Levels row to reveal sliders for the Black, 
White, and Bias parameters. These sliders, which mirror the settings of the Levels handles 
described above, allow you to keyframe the three Levels parameters (via the Add Keyframe 
button to the right of each slider). Keyframing the Black, White, and Bias parameters may yield 
a better key, one that adapts to changing blue-screen or green-screen conditions.
• Shrink/Expand: Use this slider to manipulate the contrast of the matte to affect matte 
translucence and matte size simultaneously. Drag the slider left to make translucent regions 
more translucent while simultaneously shrinking the matte. Drag the slider right to make 
translucent regions more solid while simultaneously expanding the matte.
• Soften: Use this slider to blur the keyed matte, feathering the edges by a uniform amount.
• Erode: Drag this slider right to gradually increase transparency from the edge of the solid 
portion of the key inward.
4 Click Light Wrap to reveal the following controls:
• Amount: Use this slider to control the overall light wrap effect, setting how far into the 
foreground the light wrap extends.
• Intensity: Use this slider to adjust gamma levels to lighten or darken the interaction of wrapped 
edge values with the keyed foreground subject.
• Opacity: Use this slider to fade the light wrap effect up or down.
• Mode: Use this pop-up menu to choose the compositing method that blends the sampled 
background values with the edges of the keyed subject. There are five modes:
• Normal: Evenly blends light and dark values from the background layer with the edges of the 
keyed foreground layer.
• Lighten: Compares overlapping pixels from the foreground and background layers, and then 
preserves the lighter of the two. Good for creating a selective light wrap effect.Chapter 12 Keying and compositing 348
• Screen: Superimposes lighter portions of the background layer over wrapped areas of the 
keyed foreground layer. Good for creating an aggressive light wrap effect.
• Overlay: Combines the background layer with the wrapped areas of the keyed foreground 
layer so overlapping dark portions become darker, light portions become lighter, and colors 
become intensified.
• Hard Light: Similar to the Overlay composite mode, except that colors become muted.
Finalize the key
Quite often your foreground image will have objects that you don’t want to appear in the 
composited output. These could be production items like microphone booms and light stands 
or the edges of the chroma key backdrop. Additionally, you might need to resize or reposition 
the foreground object to better fit with the background. As a final step, you can use the color 
corrector to adjust the foreground so that it matches the look of the background.
Final Cut Pro includes effects that you can use for these purposes.
Use the Mask effect
1 In the Timeline, move the playhead to the point in the background clip (the clip you want to 
superimpose the chroma key clip over) where you want the key to start.
2 In the Event Browser, select the part of the foreground clip (the chroma key clip with the color 
you want to remove) you want to key over the background, and choose Edit > Connect to 
Primary Storyline (or press Q).
Foreground
Background 
attached as a 
connected clip
For details about connecting clips in this way, see Connect clips to add cutaway shots, titles, and 
synchronized sound effects on page 103.Chapter 12 Keying and compositing 349
3 Select the foreground clip.
In the above example, the light stands need to be removed.
4 Click the Effects button in the toolbar.
5 In the Effects Browser, double-click the Mask effect to apply it to the selected foreground clip.
Tip: Type “mask” in the Effects Browser’s search field to quickly find the mask effect.Chapter 12 Keying and compositing 350
6 Adjust the four corners of the mask to crop out the objects you want to remove, in this case, the 
light stands.
When adjusting the mask, be sure to leave shadows and other details that can help make the key 
more realistic later.
7 Apply the appropriate keyer effect to the foreground clip.
The foreground is composited over the background.Chapter 12 Keying and compositing 351
Use Transform to position the foreground image
The following steps assume you have already configured a key but need to reposition the 
foreground image.
1 Select the foreground clip in the Timeline.
2 In the lower-left corner of the Viewer, choose Transform from the pop-up menu and move the 
image to the position you want. In the above example, you might want to move the woman to 
the left.
You can also resize the image.
3 Click Done in the Viewer when you are finished repositioning the foreground image.
Compositing
Compositing overview
Compositing refers to combining parts of two or more video clips into a single image. There are 
a number of ways to combine video images in Final Cut Pro:
• Transitions: All video transitions involve combining the end of one clip with the start of a 
second clip, which results in a combination of the two clips appearing at the same time during 
the transition. 
• Keying: All keys involve compositing a foreground image over a background image.Chapter 12 Keying and compositing 352
• Alpha channels: Many computer-generated video clips have an alpha channel—a built-in 
mask—that defines precisely the areas of the clip that are composited over a background 
clip. These require no key setup and generally just automatically work. Many effects, such as 
Transform and Distort; generators, such as Shapes and Timecode; and titles use alpha channels.
• Compositing: Each video clip in the Timeline has a set of Compositing settings. These are used 
when you want to combine clips without using the key effects.
Use alpha channels
Alpha channels provide an easy way to composite one image over another. Using an application 
like Motion, an Apple application designed to work with Final Cut Pro, you can create still images 
and video clips that have alpha channels. Alpha channels can be thought of as having a built-in 
keyer—when you use the key effects you are creating a mask that is used in the same way a clip 
with an alpha channel is used for compositing.
Below is an example of a clip with an alpha channel, showing the image that fills the 
alpha channel.
Below is the alpha channel image—the white areas define the video areas that are composited 
over the background. The gray areas (which define the shadow in this example) define parts of 
the image that are partially transparent.Chapter 12 Keying and compositing 353
This is what the final composite looks like over a background clip.
Use a clip with an alpha channel
1 Position the playhead in the Timeline where you want to add the alpha channel clip.
2 Select the clip that has an alpha channel in the Event Browser, and choose Edit > Connect to 
Primary Storyline (or press Q). 
3 To see the composited clips, position the playhead within the clip that was just added above the 
primary storyline.
Connected clip 
(composite foreground)
Primary storyline clip 
(composite background)
The clip is composited over the primary storyline video clip, with the alpha channel controlling 
the opacity of its clip.
You can also use the Opacity adjustment’s fade handles to dissolve the foreground clip on 
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Use Compositing settings
The Compositing settings provide a wide variety of options for combining two images. You can 
make a simple adjustment to evenly combine two images, or you can choose from settings that 
use the video content to determine how to combine the images.
Use the Opacity adjustment
1 Position the playhead in the Timeline where you want to add a clip above the primary storyline.
2 Select the clip to add in the Event Browser, and choose Edit > Connect to Primary Storyline (or 
press Q). 
3 To see the composited clips, position the playhead within the clip that was just added.
By default, the new clip completely obscures the clip on the primary storyline.
4 To make the new clip partially transparent, select it in the Timeline and adjust the Opacity 
control in the Compositing section of the Video inspector.
The closer you set Opacity to 0 percent, the more transparent the clip above the primary 
storyline becomes. Additionally, you can use the Opacity fade handles in the Video Animation 
Editor to have the composited clip dissolve on and off, or add keyframes to have the opacity 
value change at specified points.
Choose a blend mode
1 Position the playhead in the Timeline to where you want to add a clip above the 
primary storyline.
2 Select the clip to add in the Event Browser, and choose Edit > Connect to Primary Storyline (or 
press Q). 
3 To see the composited clips, position the playhead within the clip that was just added.
By default, the new clip completely obscures the clip on the primary storyline.
4 Choose an option from the Blend Mode pop-up menu in the Compositing section of the 
Video inspector.
There are many blend mode settings to choose from—the correct one to use depends on the 
video content and the sort of look you are aiming for. Additionally, you can adjust the Opacity 
control to make the blend mode setting more subtle.355
Color correction overview
In any post-production workflow, color correction is generally one of the last steps in finishing an 
edited program. There are a number of reasons to color correct your footage:
• Make sure that key elements in your program, such as flesh tones, look the way they should
• Balance all the shots in a scene to match
• Correct errors in color balance and exposure
• Achieve a look, such as making the scenes warmer or cooler
• Create contrast or special effects by manipulating the colors and exposure
Final Cut Pro color correction tools give you precise control over the look of every clip in your 
project, including still images, by letting you adjust each clip’s color balance, shadow levels, 
midtone levels, and highlight levels. Final Cut Pro also includes several automatic tools you can 
use to quickly balance and match the color in clips. In Final Cut Pro, you can:
• Automatically balance colors: With one click, neutralize any color casts and maximize image 
contrast. See Color balance overview on page 356.
• Automatically match a clip’s color and look: With two clicks, make one or more clips match 
the color look of any clip that you choose. See Match color between clips automatically on 
page 358.
• Manually adjust color, saturation, and exposure: Manually correct a clip’s overall color, or use 
color or shape masks to limit a correction to a particular color range or area in the image. 
You can even add multiple manual color corrections to one clip. See Manual color correction 
overview on page 359.
• Save color correction settings and apply them to other clips: Save a clip’s color correction settings 
and apply them to other clips in the project or in other projects. See Save and apply color 
correction presets on page 368.
Although these features are independent of one another—you can turn any of the features 
off and on to see its effect—the order in which you use them matters. In general, you should 
use these features in the order of Balance Color, Match Color, and (if necessary) manual 
color correction.
Final Cut Pro also includes several video scopes you can use when manually color correcting 
your video. The scopes make it possible to precisely monitor the luma and chroma levels of your 
video clips.
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Analyze and balance color automatically
Color balance overview
Final Cut Pro includes an automatic color-balancing feature. When you use the color-balancing 
feature, Final Cut Pro samples the darkest and lightest areas of the image’s luma channel and 
adjusts the shadows and highlights in the image to neutralize any color casts. In addition, 
Final Cut Pro adjusts the image to maximize image contrast, so that the shot occupies the widest 
available luma range.
The video frame used as the reference frame depends on whether the clip has already been 
color analyzed:
• If the clip has been color analyzed, either during import or while in the Event Browser: The analysis 
process extracts color balance information for the entire clip. Whether you add a portion of 
the clip or the entire clip to a project, the color-balancing feature chooses the frame within 
the project clip that is closest to being correctly balanced. This means that if you add multiple 
partial clips from the same Event Browser clip to the project, each clip is balanced based on 
analysis information for its own section of media.
• If the clip has not been color analyzed and you balance its color: You can determine the reference 
frame for a clip selected in the Timeline by moving the playhead to that frame in the clip. 
If the playhead is on a different clip or you’ve selected a clip in the Event Browser, the clip’s 
middle frame is used.
Analyze a clip for color balance
To automatically balance a clip’s color, Final Cut Pro uses a single frame from the clip as a 
reference and calculates a correction for it that is then applied to the entire clip. Analyzing a clip 
for color balance allows Final Cut Pro to choose a representative frame as the clip’s color balance 
reference frame.
You can have a clip’s color balance analyzed when you import it, whether importing from a 
camera, importing a file, or dragging a clip directly to the Timeline from a Finder window. You 
can also analyze a clip’s color balance at any time in the Event Browser.
Analyzing a clip for color balance can take from a few seconds for shorter clips to a minute 
or more for longer clips. The analysis process takes longer if you also analyze for people and 
stabilization issues.
After a clip has been analyzed for color balance, you can turn the color balance correction on or 
off at any time. By default, color balance correction is off for clips in the Event Browser and on for 
clips in the Timeline, if they have been analyzed. For information about turning the color balance 
correction on and off, in either the Event Browser or the Timeline, see Balance a clip’s colors on 
page 357.
Analyze color balance during file import
1 Choose File > Import Media (or press Command-I).
2 Select the files to import, and select “Analyze for balance color” in the Video section of 
the window.
3 Click Import.
The files are imported and analyzed for color balance issues.Chapter 13 Color correction 357
Analyze color balance for clips dragged to the Timeline from the Finder
1 Choose Final Cut Pro > Preferences, or press Command-Comma (,).
2 In the Final Cut Pro Preferences window, click the Import button and select “Analyze for balance 
color” in the Video section.
All clips that you drag directly to the Timeline from the Finder are now analyzed.
Note: When you change this setting in the Preferences window, the setting is also changed in all 
other windows with an “Analyze for balance color” option.
Analyze color balance for clips in the Event Browser
When you analyze the color balance of clips in the Event Browser, any clips that were analyzed 
during import are skipped.
1 Select one or more clips in the Event Browser.
2 Do one of the following:
• Choose Modify > Analyze and Fix.
• Control-click one of the selected clips and choose Analyze and Fix from the shortcut menu.
3 In the window that appears, select “Analyze for balance color” in the Video section and click OK.
Balance a clip’s colors
Clips in Final Cut Pro have a Balance setting that turns automatic color balance correction on 
and off, whether the clip is in the Event Browser or the Timeline. The frame used as the reference 
frame is either a frame chosen during color balance analysis, the frame the playhead is on in the 
Timeline, or the middle frame. For more information, see Color balance overview on page 356.
Turn a clip’s color balance correction on and off
1 Select one or more clips in the Timeline or the Event Browser.
2 Do one of the following:
• Choose Modify > Balance Color (or press Command-Option-B).
• Choose Balance Color from the Enhancements pop-up menu in the toolbar.
• In the Color section of the Video inspector, select or deselect the Balance checkbox.
Click to turn Balance on or off.
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Match color between clips automatically
Your project likely uses video from a wide variety of sources. The Match Color feature makes it 
easy to ensure that all scenes that take place in the same location have the same look.
Match color between clips
1 Select one or more clips in the Timeline that you want to adjust.
2 Do one of the following:
• Choose Modify > Match Color (or press Command-Option-M).
• Choose Match Color from the Enhancements pop-up menu in the toolbar.
• In the Color section of the Video inspector, click the Choose button next to Match Color.
The Viewer changes to display the Timeline playhead’s frame on the right and the frame the 
pointer is over on the left.
The clip that the pointer is 
over is the color match source. 
Click to preview the color match.
The selected 
Timeline clip is the 
color match target.
3 Skim any clip in the Timeline or the Event Browser to find a frame with the color look you want 
to match, and click to preview that look applied to the selected clip.
You can click a variety of clips until you find the look you want.
Tip: You may want to import a still image that has the look you want, even if it’s not related to 
your project, so that you can match its color look.
4 To accept the current look, click Apply Match in the Match Color window.
The Viewer returns to its normal configuration, and the selected Timeline clips change to the 
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Turn match color corrections on or off
You can turn off the color match corrections that have been applied to a clip. This is useful for 
viewing the difference between the original clip and the corrected clip.
1 In the Timeline, select a clip with match color corrections applied.
2 Click the Color Match checkbox in the Color section of the Video inspector.
Adjust color manually
Manual color correction overview
Final Cut Pro includes a powerful manual color correction tool that you can use to accomplish a 
wide variety of color correction or enhancement effects:
• Apply a color correction to the whole image: Adjust the color tint, color saturation, and exposure 
for the whole clip image. See Color correct the whole image on page 359.
• Choose a specific color in the image to correct: For example, choose a brightly colored object, 
such as a shirt or car, and use the color correction settings to mute or change the color. See 
Target a specific color using a color mask on page 361.
• Choose an area of the image to correct: Draw one or more shape masks, and then choose 
whether the correction applies inside or outside the masks. You can even have the position of 
the masks change as the clip plays. See Target specific areas using shape masks on page 363.
You can also apply multiple color corrections to a single clip and use shape masks in 
combination with a color mask. For example, you could use one correction to set the clip’s overall 
color look, a second to target and alter a specific color, and a third to target a different color or an 
area defined by a shape mask. See Apply multiple color corrections on page 367 and Add shape 
masks to a color mask on page 366.
You make manual color adjustments using the Color Board.
Color correct the whole image
You use the Color Board to manually adjust a clip’s color, saturation, and exposure.
Manually color correct the whole clip image
1 Select a clip in the Timeline, and do one of the following:
• Choose Window > Go To > Color Board (or press Command-6).
• Choose Show Color Board from the Enhancements pop-up menu in the toolbar.
• Click the Color Board button in the Color section of the Video inspector. (After you make 
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• Click the upper-left corner of a clip in the Timeline and choose Color Adjustment from the 
pop-up menu.
Click to return to the 
Video inspector.
Click the Reset button to 
remove the adjustments 
in this pane.
Choose the correction 
to work with.
Drag the controls to 
change the values.
Use value sliders to 
change the values.
Use the Action pop-up menu 
to create or choose a color 
correction preset.
2 If the clip has multiple corrections applied to it, choose the correction to adjust from the 
Correction pop-up menu in the Color Board’s upper-right corner.
3 To add or remove a color tint, click Color (or press Command-Control-C), and drag the controls in 
the Color pane.
• To adjust the tint for the whole image: Drag the Global control (the large gray control).
• To adjust the tint in the darker areas of the image: Drag the Shadows control (the black control).
• To adjust the tint in the midtones: Drag the Midtones control (the small gray control).
• To adjust the tint in the brighter areas of the image: Drag the Highlights control (the white control).
Dragging the controls up adds the color to the video, and dragging them down subtracts the 
color (effectively adding the opposite color). Dragging the controls left and right chooses the 
color to add or subtract.
You can also select the control and enter values numerically using the corresponding value slider. 
Tip: To move the selected Color Board control up or down, press the Up Arrow or Down Arrow 
key. In the Color pane, you can also use the Left Arrow or Right Arrow key to move the selected 
control left or right.
4 To adjust the clip’s chroma level, click Saturation (or press Command-Control-S), and drag the 
controls in the Saturation pane. 
• To adjust saturation for the whole image: Drag the Global control on the left.
• To adjust saturation in the darker areas of the image: Drag the Shadows control.
• To adjust saturation in the midtones: Drag the Midtones control.
• To adjust saturation in the brighter areas of the image: Drag the Highlights control.
Dragging the controls up increases the chroma level, and dragging them down reduces the level. 
These controls do not move left and right.
You can also select the control and enter values numerically using the corresponding value slider. Chapter 13 Color correction 361
5 To adjust the clip’s luma level, click Exposure (or press Command-Control-E), and drag the 
controls in the Exposure pane.
• To adjust exposure for the whole image: Drag the Global control on the left.
• To adjust exposure in the darker areas of the image: Drag the Shadows control.
• To adjust exposure in the midtones (similar to a gamma control): Drag the Midtones control.
• To adjust exposure in the brighter areas of the image: Drag the Highlights control.
Dragging the controls up increases the luma level, and dragging them down reduces the level. 
These controls do not move left and right.
You can also select the control and enter values numerically using the corresponding value slider. 
You can use the Command Editor to assign a keyboard shortcut to turn color corrections on 
and off while making adjustments in the Color Board, and to assign keyboard shortcuts to many 
other Color Board functions. For more information, see View keyboard shortcuts in the Command 
Editor on page 452.
Reset and turn off Color Board color corrections
1 In the Timeline, select a clip whose color corrections you want to remove.
2 In the Color Board, do any of the following:
• To reset the currently selected control to its neutral state: Press Delete.
• To reset all of a pane’s controls to their neutral state: Click the Reset button in the pane’s 
upper-right corner.
• To reset all three Color Board panes back to their neutral state: In the Color section of the Video 
inspector, click the Reset button to the right of the Correction setting.
Click here to turn the 
correction on or off.
Color Board 
Reset button
• To turn Color Board corrections off without resetting them: In the Color section of the Video 
inspector, deselect the checkbox for the correction.
Turning the corrections off and on makes it easy to quickly see the effect of your adjustments.
Target a specific color using a color mask
A color mask isolates a particular color in the image. You can apply a color mask to a clip to 
correct a specific color, or to exclude that color from corrections to the rest of the image, or both. 
For example, you could mute a brightly colored shirt in the background that distracts attention 
from a clip’s main subject.
Using a color mask to control the color correction allows you to pick a color and then 
independently adjust that color (reduce, enhance, or change it) or adjust everything except that 
color (for example, add a tint or reduce the brightness or chroma levels).Chapter 13 Color correction 362
Add a color mask to a color correction
1 In the Timeline, select a clip with a color that you want to mute or enhance.
2 Click the Add Color Mask button in the Color section of the Video inspector.
Click here to add 
a color mask.
The Color Mask section appears.
Selected mask color
When the button is 
highlighted, use the 
eyedropper to select the 
mask color in the Viewer.
Sets edge softness
3 In the Viewer, position the eyedropper on a color in the image that you want to isolate, and drag 
to select the color.
Drag to select the 
color to mask.
As you drag, two concentric circles appear. The size of the outer circle determines the range of 
variations in the selected color that are included in the color mask. As you change the outer 
circle size, the image becomes monochrome except for the color you are selecting. You can drag 
a new selection circle as many times as you like to try for better results.
Note: When you stop dragging, the picture returns to its original look, but you’ll see the effects 
of the color mask you have created as soon as you start making adjustments in the Color Board. 
You can then return to the Video inspector and use the eyedropper to make any adjustments to 
the color mask.
4 To change the range of color variations included in the mask, do either of the following:
• To add color shades: Hold down the Shift key, position the eyedropper on a color you want to 
add to the mask, and drag to select the color.
• To subtract color shades: Hold down the Option key, position the eyedropper on a color you 
want to remove from the mask, and drag to select the color.
5 To adjust the color mask edges, drag the Softness slider.
To have the Viewer temporarily show the color mask, hold down the Option key and then drag 
the Softness control: white indicates fully opaque mask areas, black indicates areas outside the 
mask, and levels of gray indicate transparent mask areas.Chapter 13 Color correction 363
6 To adjust the color correction settings for this color mask, click the Color Board button in the 
Video inspector. (After you make any Color Board adjustments, the button color changes.)
7 Do one of the following:
• To apply a color correction to the selected color: Click Inside Mask. 
• To apply a color correction to everything except the selected color: Click Outside Mask.
You can make corrections to both the inside and outside areas of the mask—each area 
effectively has its own complete set of Color Board controls. For example, you could select Inside 
Mask and enhance the targeted color, and then select Outside Mask to darken everything else.
8 Adjust the Color Board controls to create the effect you want.
For more information about working with the Color Board, see Color correct the whole image on 
page 359.
To limit the area of the image affected by a color mask, you can add a shape mask. For more 
information, see Add shape masks to a color mask on page 366.
Target specific areas using shape masks
A shape mask defines an area in the image so that you can apply color corrections either inside 
or outside that area. For example, you might want to emphasize a subject’s face by darkening the 
area around the face.
You can add multiple shape masks to define multiple areas, and you can also animate the shapes 
so that they follow an area while a camera pans or an object moves as the clip plays.
Add a shape mask
1 In the Timeline, select a clip with an area whose color you want to mute or enhance.
2 Click the Add Shape Mask button in the Color section of the Video inspector.
Click here to add 
a shape mask.
A Shape Mask area appears.
Click here to show or 
hide the shape mask 
onscreen controls.Chapter 13 Color correction 364
3 To adjust the default shape that appears in the Viewer, do any of the following:
Drag this handle to make 
the shape rectangular.
Drag the outer edge 
to control the softness.
Drag any of these 
handles to change the 
shape’s width or height.
Drag the center circle 
to move the shape.
Drag this handle 
to rotate the shape.
• To position the shape: Drag the center.
• To adjust the shape’s width or height: Drag any of the four handles at the 90-degree points (top, 
bottom, left, or right) of the inner circle. You can hold down the Shift key while dragging to 
force all sides to scale proportionally.
• To control the roundness of the shape: Drag the handle to the left of the inner circle’s top handle.
• To rotate the shape: Drag the rotation handle (extending from the center).
• To control the softness of the shape’s edge: Drag the outer circle. Setting the outer circle close 
to the inner circle creates a hard edge and an abrupt transition to the corrections you apply, 
and dragging the outer circle away from the inner circle creates a softer edge and a more 
gradual transition.
• To hide the mask’s controls: Click the Shape Mask onscreen controls button in the Shape Mask 
area of the Color section of the Video inspector.
4 To adjust the color correction settings for this shape mask, click the Color Board button in the 
Video inspector. (After you make any Color Board adjustments, the button color changes.)
5 Do one of the following:
• To apply a color correction to the shape area: Click Inside Mask.
• To apply a color correction to everything except the shape area: Click Outside Mask.
You can make corrections to both the inside and outside areas of the mask—each area 
effectively has its own complete set of Color Board controls. For example, you could select Inside 
Mask and enhance the shape’s area, and then select Outside Mask to darken everything else.
6 Adjust the Color Board controls to create the effect you want.
For more information about working with the Color Board, see Color correct the whole image on 
page 359.
7 To add additional shapes to the correction, click the Add Shape Mask button in the color 
correction’s area in the Video inspector again.
Another default shape appears in the Viewer, and the original shape is dimmed. You can select 
and continue configuring the original shape by clicking its center.Chapter 13 Color correction 365
Delete a shape mask
1 In the Video inspector, select the Shape Mask item you want to delete.
Select a Shape Mask 
item and press Delete.
2 Press Delete.
Note: If you delete all shape masks in the correction, the Inside Mask corrections are applied to 
the whole image.
Animate a shape mask
You can use keyframes to animate a shape mask so that it follows the movement of an 
onscreen object.
1 To add a shape mask, follow the instructions in “Add a shape mask,” above.
2 In the Timeline, position the playhead on the clip with the shape mask at the frame where you 
want the shape to begin moving.
3 Position the shape mask to its starting position in the Viewer.
4 In the Video inspector, click the Keyframe button.
Click here to add 
a keyframe.
A keyframe is added at the position of the playhead. You can see it in the Timeline by pressing 
Control-V to open the Video Animation Editor. The keyframe appears in the Color section as a 
diamond at the playhead position.
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5 Move the playhead to the next point in the clip where you want to define the shape mask’s 
position, reposition the shape mask, and add the second keyframe.
6 To reposition the shape mask throughout the clip, continue adding keyframes until you’ve 
defined the shape movement you want.
When you’ve added all the keyframes, you can play the clip to see the shape mask move 
between them. For more information about working with keyframes, see Video animation 
overview on page 247.
Add shape masks to a color mask
Often when you create a color mask, more areas of the video are affected by it than you would 
like. For example, there might be a red car on the left side of the screen that you want to color 
correct, and a red stop sign on the right that you don’t want to affect. In this situation, you can 
add one or more shape masks to restrict the color mask to the areas defined by the shape masks.
Add a shape mask to a color mask
1 Select a clip in the Timeline, and use the Video inspector to add a color mask to it.
2 Apply a color correction using the Color Board, and note areas of the video that you don’t want 
the color mask to affect.
For more information about working with the Color Board, see Color correct the whole image on 
page 359.
3 In the Video inspector, click the Add Shape Mask button in the correction that has the 
color mask.
Click here to add 
a shape mask 
to the correction.
4 Adjust the shape mask so that it overlaps the part of the color mask you want to use.
5 To adjust the color correction settings, click the Color Board button in the Video inspector. 
(After you make any Color Board adjustments, the button color changes.)
6 Do either of the following:
• To make color correction adjustments that apply only to the areas of overlap between the color 
mask and shape mask: Select Inside Mask, at the bottom of the Color Board.
• To make color correction adjustments that apply outside the areas of overlap between the color 
mask and shape mask: Select Outside Mask.
If necessary, you can add additional shape masks, and even animate them.Chapter 13 Color correction 367
Apply multiple color corrections
You can apply multiple color corrections to a clip to target specific issues. For example, you could 
have one color correction that mutes a bright orange shirt and a second one that enhances the 
green in the lawn.
Color masks are created based on the original colors in the clip. For example, if the first color 
correction removes all chroma from the clip, the second color correction can still create a color 
mask based on a color originally in the clip.
Apply multiple color corrections to a clip
1 Select a clip in the Timeline.
2 To add an additional color correction item, click the Add Correction button in the 
Video inspector.
Click here to add a correction.
By default, the Color section contains the first manual color correction item (Correction 1) 
along with the Balance and Match Color items. Color correction items that you add are named 
Correction 2, Correction 3, and so on. Each correction item has its own Color Board button—
clicking one of these opens the Color Board with that correction’s settings. You can also choose a 
correction in the Color Board using the pop-up menu in the upper-right corner.
Note: If you have applied multiple corrections to a clip, you can drag them in the Video inspector 
to change their order. Rearranging the processing order can provide different results.
View color correction keyframes in the Timeline
If a clip has multiple corrections with animated shape masks, you can view a correction’s shape 
mask keyframes in the Video Animation Editor above the clip in the Timeline.
1 In the Timeline, select a clip that has multiple color corrections with animated shape 
masks applied.
2 Choose Clip > Show Video Animation (or press Control-V).
3 Choose the color correction you want to view from the Color pop-up menu:
• To see a composite of keyframes from all corrections: Choose the correction, and if it contains 
multiple shape masks, choose the one you want to see.
• To see keyframes from a specific shape mask in a correction: Choose the correction, and if it 
contains multiple shape masks, choose the one you want to see.
When you choose a specific correction, such as Correction 2, you see its keyframes in white 
and the keyframes of other corrections in dark gray.Chapter 13 Color correction 368
Add a transition between color corrections
You can have a video clip change from one color correction to another using a transition. 
For example, if you want a scene to gradually highlight the two main characters, you can use 
a transition to dissolve between the normal clip and the clip with shape masks and a color 
correction applied that darkens the image outside of the masks.
Important: Make sure that Available Media is chosen from the “Apply transitions using” pop-up 
menu in the Editing pane of Final Cut Pro preferences. For more information about this setting, 
see How transitions are created on page 205.
Configure a clip to change transitions
1 Temporarily switch to the Blade tool by holding down the B key.
2 In the Timeline, click a video clip at the point where you want to change between 
color corrections.
The clip splits into two clips.
3 Apply a different color correction to each clip.
You can also leave one clip uncorrected and apply a color correction to the other. 
The color correction could be an exaggerated tint, an exposure change, or any other 
noticeable adjustment.
4 Select the edit point between the two clips, and press Command-T to insert a cross dissolve.
When you play the clip, one color correction dissolves into the other as the edit point is passed.
Save and apply color correction presets
With Final Cut Pro, you can save a clip’s color correction settings as a preset, making it easy to 
apply those settings to other clips in the same project or a different project.
Final Cut Pro includes several presets you can use in addition to any that you create.
Note: Color correction presets save the current Color, Saturation, and Exposure settings only. 
They do not save the mask settings, including whether you have Inside Mask or Outside 
Mask selected.
Save a color correction preset
1 In the Timeline, select a clip that has the color correction look you want to save, and open 
the Color Board.
2 Choose Save Preset from the Action pop-up menu in the lower-right corner of the 
Color Board.
3 Type a name for the preset and click OK.
Apply a color correction preset
1 Select a clip in the Timeline, and open the Color Board.
2 Choose a preset from the Action pop-up menu in the lower-right corner of the Color Board.
The preset’s adjustments are applied to the selection. After the preset has been applied, you can 
modify the settings using the Color Board.Chapter 13 Color correction 369
Turn iMovie adjustments on or off
When editing a project in iMovie, you can adjust several video attributes, such as exposure, 
brightness, and saturation, in the Project Browser. If you import an iMovie project that has these 
adjustments into Final Cut Pro, the adjustments are retained and appear in the Color area of the 
Video inspector as an iMovie item.
Although you cannot modify the adjustments added in iMovie, you can choose whether they are 
applied to the clip or not.
Note: Video adjustments you make to clips in the iMovie Event Browser are not retained and do 
not appear in Final Cut Pro.
Turn a clip’s iMovie adjustments on or off
m In the Timeline, select a clip with iMovie adjustments applied, and select or deselect the iMovie 
checkbox in the Color area of the Video inspector.
Click here to turn the iMovie 
adjustments on or off.
Note: The iMovie adjustments appear only in the Timeline, not in the Event Browser.
For more information about importing iMovie projects, see Import from iMovie on page 32.
Turn ARRI Log C processing on or off
Log C is a recording option on the ARRI Alexa camera that enables a greater dynamic range to 
be captured in the Apple ProRes file. By default, Final Cut Pro properly displays Apple ProRes 
media captured with this recording option and imported with Final Cut Pro X 10.0.8 or later. If 
Log C media was imported into an earlier version of Final Cut Pro X, Log C processing is disabled 
by default for that media.
Turn a clip’s ARRI Log C processing on or off
1 Select a clip recorded with the ARRI Alexa camera Log C option.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 In the Info inspector, choose Settings View from the Metadata View pop-up menu.
4 To turn Log C processing on or off, select or deselect the Log Processing checkbox.Chapter 13 Color correction 370
Measure video levels
Video scopes overview
Broadcast facilities have limits on the maximum values of luma and chroma that are allowable 
for broadcast. If a video program exceeds these limits, distortion can appear in the form of colors 
bleeding into one another, the whites and blacks of your program washing out, or the picture 
signal bleeding into the audio signal and causing audible distortion. In all these cases, exceeding 
standard signal levels can result in unacceptable transmission quality. As you’re color correcting 
clips in your project, you can use the Final Cut Pro video scopes to make sure that the luma 
and chroma levels of your video stay within the parameters referred to as broadcast-safe, or 
acceptable for broadcast.
Even if your project is not intended for broadcast, using the video scopes is an important part 
of your workflow. If the monitors you’re using don’t display color accurately or you’ve been 
working with the same clips for a while, you can easily get used to seeing a color cast or blacks 
that are not quite right. The scopes provide exact measurements of the luma and chroma levels 
of your clips so that you can make more informed decisions about adjusting Final Cut Pro color 
correction settings.
Final Cut Pro provides the following video scopes:
• Waveform Monitor
• Vectorscope
• Histogram
Use the video scopes
By default, the video scopes appear to the left of the video image in the Viewer and the Event 
Viewer. Each viewer displays only one scope at a time.
Open a scope
1 Do one of the following:
• To open a video scope in the Viewer: Choose Window > Viewer Display > Show Video Scopes (or 
press Command-7).
• To open a video scope in the Event Viewer: Choose Window > Event Viewer Display > Show 
Video Scopes.
In either the Viewer or the Event Viewer, you can also choose Show Video Scopes from the 
Viewer Options pop-up menu in the top-right corner.
You can use the same commands to close the video scope.Chapter 13 Color correction 371
2 Choose the scope to display from the top section of the Settings pop-up menu.
Choose the scope you 
want to use from the 
Settings pop-up menu.
Viewer Options 
pop-up menu
3 After you choose a scope, choose the display options from the bottom section of the Settings 
pop-up menu.
Note: You may find it convenient to display scopes below the video image in the Event Viewer. 
To do so, choose Vertical Layout from the Settings pop-up menu in the Event Viewer. For more 
information, see Play back and skim media in the Event Viewer on page 78.
Waveform Monitor display options
The Waveform Monitor shows the relative levels of luma and chroma in the clip currently being 
examined. These values are displayed from left to right, mirroring the relative distribution of luma 
and chroma levels from left to right in the image. Spikes and dips in the displayed waveforms 
correspond to light and dark areas in your picture. The waveforms are also tinted to match the 
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The Settings pop-up menu in the upper-right corner of the Waveform Monitor provides a variety 
of display options:
• RGB Parade: Presents three side-by-side waveform displays that display your video as three 
separate red, green, and blue components. The waveforms are tinted red, green, and blue so 
that you can easily identify them.
The RGB Parade view is useful for comparing the relative levels of red, green, and blue 
between two clips. If one clip has more blue than another, the Waveform Monitor displays 
an elevated blue waveform for the clip with more blue and a depressed blue waveform for 
the other clip.
• RGB Overlay: Combines waveforms for the red, green, and blue color components in 
one display.
• Red: Shows only the red color channel.
• Green: Shows only the green color channel.
• Blue: Shows only the blue color channel.
• Luma: Shows only the luma component of the video.Chapter 13 Color correction 373
• Chroma: Shows only the chroma component of the video, and is tinted to match the 
video’s colors.
• Y'CbCr Parade: Presents three side-by-side waveform displays for the separate luma, Cb (the 
blue color difference channel), and Cr (the red color difference channel) components. The 
waveforms are tinted white (for luma), magenta (for Cb), and yellow (for Cr) so that you can 
easily identify the waveform for each component.
• IRE: Displays the video range in IRE units.
• Millivolts: Displays the video range in millivolts.
• Guides: Turns the Waveform Monitor’s grid and numeric values on or off.
• Monochrome: Dims and desaturates the scope display to prevent visual distractions and color 
perception issues in your color-finishing suite.
• Brightness: Sets the relative lightness or darkness of the scope display.Chapter 13 Color correction 374
Vectorscope display options
The Vectorscope shows the distribution of color in your image on a circular scale. The color in 
your video is represented by a series of connected points that fall somewhere within this scale. 
The angle around the scale represents the hue displayed, with targets indicating the primary 
colors of red, green, and blue and the secondary colors of yellow, cyan, and magenta. The 
distance from the center of the scale to the outer ring represents the saturation of the color 
being displayed. The center of the scale represents zero saturation, and the outer ring represents 
maximum saturation.
The Vectorscope shows you, at a glance, the hue and intensity of the various colors in your 
image. Once you learn to identify the colors in your clips using the Vectorscope, you can more 
easily see where two images differ and correct them so that they match as closely as possible.
The Settings pop-up menu in the upper-right corner of the Vectorscope provides a variety of 
display options:
• 100%: Sets the reference chroma level for the color bar targets (the squares representing each 
color in a standard color bar test signal) at 100 percent saturated chroma. Use this when your 
source media uses 100 percent color bars as its reference.
• 133%: Sets the reference chroma level for the color bar targets at 75 percent saturated chroma. 
Use this when your source media uses 75 percent color bars as its reference.
• Vector: Uses a normal chroma hue reference, with red near the top.
• Mark3: Uses a 90-degree rotated chroma hue reference, with red on the right side.
• Show/Hide Skin Tone Indicator: Shows or hides the diagonal line that represents the human skin 
tone chroma phase, which is between the yellow and red color bar targets.
• Monochrome: Dims and desaturates the scope display to prevent visual distractions and color 
perception issues in your color-finishing suite.
• Brightness: Sets the relative lightness or darkness of the scope display.Chapter 13 Color correction 375
Histogram display options
The Histogram provides a statistical analysis of the image by calculating the total number of 
pixels of each color or luma level and creating a graph that shows the number of pixels at 
each percentage of luma or color. Each increment of the scale from left to right represents a 
percentage of luma or color, and the height of each segment of the Histogram graph shows the 
number of pixels that correspond to that percentage.
The Settings pop-up menu in the upper-right corner of the Histogram provides a variety of 
display options:
• Luma: Shows only the luma component of the video. The height of the graph at each step on 
the scale represents the number of pixels in the image at that percentage of luma, relative to 
all the other values. For example, if an image has few highlights, the Histogram shows a large 
cluster of values in the midtones.
Using the Luma Histogram view, you can quickly compare the luma of two shots so that you 
can adjust their shadows, midtones, and highlights to match more closely.
The shape of the graph also helps you determine the amount of contrast in an image. A 
low-contrast image has a concentrated clump of values nearer to the center of the graph. By 
comparison, a high-contrast image has a wider distribution of values across the entire width of 
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• RGB Overlay: Combines waveforms for the red, green, and blue color components in one 
display. If the image being examined has equal levels of two or more colors, you see the 
combined color:
• Equal levels of green and blue appear as cyan.
• Equal levels of green and red appear as yellow.
• Equal levels of red and blue appear as magenta.
• Equal levels of red, green, and blue appear as gray.
• RGB Parade: Presents three graphs that display your video as separate red, green, and 
blue components. The waveforms are tinted red, green, and blue so that you can easily 
identify them.
You can use the RGB Parade view to compare the relative distribution of each color channel 
across the tonal range of the image. For example, images with a red color cast have either a 
significantly stronger red graph or weaker green and blue graphs.
• Red: Shows only the red color channel.
• Green: Shows only the green color channel.
• Blue: Shows only the blue color channel.
• Brightness: Sets the relative lightness or darkness of the scope display.377
Sharing projects overview
Final Cut Pro provides a variety of destinations, or preconfigured export settings, that you 
can use to output your project or clip. For example, you can export a project or clip as a 
QuickTime movie, export it for viewing on Apple devices such as iPhone and iPad, publish it 
to websites such as Facebook and YouTube, or burn it to a disc. Each of these options uses a 
different destination.
When you first open Final Cut Pro, a default set of destinations appears in the Share submenu 
of the File menu and in the Share pop-up menu. 
Details about each destination in the default set are listed in the table below. 
Destination Use to
DVD Burn your project to a standard-definition (SD) DVD.
Master File (default) Export your project as a QuickTime movie file.
The Master File destination is the default destination. 
You can open it by pressing Command-E.
YouTube
Vimeo
Facebook
Publish your project to your account on any of 
these websites.
Apple Devices 720p Export files for iPhone and iPod. 
Apple Devices 1080p Export files for iPad. 
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You can easily replace the default set of destinations with your own customized destinations. 
You modify existing destinations and create new destinations using the Destinations pane of 
Final Cut Pro preferences. You can also create a bundle of destinations to export several types 
of output at once. For more information, see Work with destinations on page 427. 
To further customize your output, you can use Compressor, the professional transcoding 
application. For more information, see Export your project using Compressor on page 386.
Share projects, clips, and ranges
You can share an entire project, an entire clip, or a portion of a project or clip (indicated with a 
range selection). You can also share a project’s roles, exporting each role as a separate media 
stem. If you want to export the same roles from another project or clip later, you can save your 
settings as a preset.
Because the transcoding required to create the shared file happens in the background, you can 
continue working on your projects in Final Cut Pro after sharing. (Keep in mind that changes you 
make to a project after the transcoding process begins are not reflected in the output files.)
Share a project, clip, or range
1 Do one of the following:
• Select a project in the Project Library.
• Select a clip in the Event Browser.
• Select a range in a project in the Timeline or in a clip in the Event Browser. 
2 Do one of the following:
• Choose File > Share, and choose a destination from the submenu.
• Click the Share button in the toolbar, and choose a destination from the pop-up menu. Chapter 14 Share your project 379
3 In the Share window that appears, do any of the following:
Move the pointer over the 
image to skim the video.
Project 
attributes
File 
information
• Move the pointer over the image to skim the video.
• In the Info pane on the right, view and modify project or clip attributes, such as the title 
and description.
Important: By default, the title field lists the project or clip name. Changing the title does not 
change the project or clip name, which is the name used for the exported file.
All of the attributes associated with the project or clip will be included in the output file. You 
can modify the attributes that appear in the Info pane. For more information, see Modify share 
attributes on page 383.
• At the bottom of the window, view information about the file that will be exported, including 
frame size and frame rate, audio channels and sample rate, duration, output file type, and 
file size.
For some destinations, you can also view a list of devices that will play the exported file. 
To view the compatible devices, move the pointer over the Compatibility icon in the 
lower-right corner.
Move the pointer 
over the icon to view 
compatible devices.Chapter 14 Share your project 380
4 To view the destination’s settings, click Settings. 
The settings for the destination are displayed in the Settings pane. If necessary, modify the 
destination’s settings.
Note: If you change the destination’s settings, the changes are saved as the default settings for 
the destination. For more information, see Destinations preferences on page 422.
5 Click Share or Next. 
The button you see changes depending on the destination you chose. If you click Next, enter a 
name for the file, choose a location to save it, and click Save.
You can monitor the progress of the transcode in the Background Tasks window, and you can 
continue to work in Final Cut Pro while the file is transcoded.
When the transcode is complete, the transcoded file is either opened by the application specified 
in the “Open with” pop-up menu in the Settings pane, saved to the location you chose, or, if you 
used a web destination, uploaded to the website. You can view and locate shared projects in 
the Sharing inspector. For more information, see Visit, announce, and view the location of shared 
projects on page 388.
Note: If you added chapter markers to your project, chapter marker thumbnails are placed at the 
appropriate location when sharing to disc (DVD and Blu-ray disc) and MV4, QuickTime, and MP4 
formats (for playback using iTunes, QuickTime Player, and Apple devices). For more information, 
see Manage chapter markers and their thumbnail images on page 152 and Compressor Help at 
http://help.apple.com/compressor.
Share roles as separate files
You can export one or more of a project’s or clip’s roles as media stems. For example, you can 
export a project’s dialogue, music, and sound effects as separate media files by assigning roles 
to the dialogue, music, and sound effects, and then exporting the roles. You can export roles as a 
combined, multitrack QuickTime file or as separate audio or video files, and you can assign mono, 
stereo, or surround output for your audio channels. For more information, see Roles overview on 
page 299.
1 Do one of the following:
• Select a project in the Project Library.
• Select a clip in the Event Browser.
• Select a range in a project in the Timeline or in a clip in the Event Browser.
2 Choose File > Share > Master File (or click the Share button in the toolbar and choose Master File 
from the pop-up menu).
Note: You can also choose another destination you created based on the Master File or Export 
File destination. 
3 Click the Settings button, and then specify the following settings:
• Format: Choose a mastering format (Video and Audio, Video Only, or Audio Only).
• Video codec: The source codec is listed by default. Depending on your source media, you can 
choose another codec.
• Resolution: The resolution (based on the source footage) is provided. Depending on your 
source media, you can choose another resolution.
• Audio file format: The source format is listed by default. Depending on your source media, you 
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• Include chapter markers: Select the checkbox to include chapter markers with the exported file 
(or files).
• Open with: Choose what you want to happen after the export is complete.
4 In the “Roles as” pop-up menu, choose how you want the roles exported.
Note: The options available in this pop-up menu change based on your selection in the Format 
and “Audio file format” pop-up menus.
• QuickTime Movie: Exports all of the roles in the project as a single QuickTime movie.
If you choose this option, skip step 5.
• Roles As Multitrack QuickTime Movie: Exports the roles you specify as a single QuickTime movie.
• Roles As Separate Files: Exports each of the video and audio roles you specify as a separate file.
• Video Roles Only As Separate Files: Exports each of the video roles you specify as a separate file.
• Audio Roles Only As Separate Files: Exports each of the audio roles you specify as a separate file.
5 To specify which roles to export, do either of the following:
• To add a role to the export files: Click Add Video File or Add Audio File, and choose a role from 
the pop-up menu.
If you’re adding an audio role, you can also choose the channel format for the role (Mono, 
Stereo, or Surround). For more information, see Configure audio channels on page 169.
If you chose Roles As Multitrack QuickTime Movie from the "Roles as" pop-up menu, the 
Add Video File button is dimmed.
• To remove a role from the export files: Move the pointer over the role you want to remove, and 
click the Remove (–) button that appears to the right of the pop-up menu.
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6 Click Next, enter a name for the file, choose a location to save it, and click Save.
You can monitor the progress of the transcode in the Background Tasks window, and you can 
continue to work in Final Cut Pro while the file is transcoded.
When the transcode is complete, the transcoded file is either opened by the application specified 
in the “Open with” pop-up menu in the Settings pane or saved to the location you chose. You 
can view and locate shared projects in the Sharing inspector. For more information, see Visit, 
announce, and view the location of shared projects on page 388.
Save a custom preset
If you’ve created a customized list of roles to share, you can save it as a custom preset.
1 Configure your share options using the instructions in “Share roles as separate files,” above.
2 In the “Roles as” pop-up menu, do any of the following: 
• To save a new preset: Choose Save As, type a name for the preset, and click Save.
• To save a preset that you’ve modified: Choose Save. 
• To save a preset as a new preset: Choose Save As, type a name for the preset, and click Save.
• To rename a preset: Choose Rename, type a new name for the preset, and click Save.
Note: The word “edited” appears after the names of custom presets that you’ve modified.
Custom presets that you create appear at the bottom of the “Roles as” pop-up menu.
Custom presets are stored in /Users/username/Movies/Final Cut Events/Export Presets/.
Delete a custom preset
You can delete custom presets that you created.
1 Select a project or clip, click the Share button in the toolbar, and choose Master File from the 
pop-up menu.
2 In the Share window, click the Settings button, and in the “Roles as” pop-up menu, choose the 
custom preset that you want to delete. 
The custom presets are listed at the bottom of the pop-up menu.
After you choose a preset, a checkmark appears next to its name.
3 In the “Roles as” pop-up menu, choose Delete.Chapter 14 Share your project 383
Modify share attributes
Share attributes are project and clip metadata that is included with exported files. You can view 
and modify share attributes in the Share inspector.
Attribute fields
Show and modify share attributes for a clip or project
1 Select a clip or project.
2 To open the Share inspector, click the Inspector button in the toolbar (shown below), and click 
the Share button at the top of the pane that appears.
3 If the attributes for the selection aren't shown, move the pointer over Attributes and click Show. 
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4 Type new text in an attribute field.
If you type a word or phrase that has been defined as an attribute, the attribute (a word or 
phrase in a blue bubble) appears after you finish typing. 
Attribute fields
Modify the attribute fields that are displayed in the Share inspector
1 Select a clip or project.
2 Open the Share inspector.
The Share inspector contains a pop-up menu you can use to customize attribute fields.
Click to view options 
for customizing 
attribute fields.Chapter 14 Share your project 385
3 Using the Attributes pop-up menu, do any of the following:
• To add an attribute field: Choose the field name (so that there’s a checkmark next to it).
Fields with a checkmark are shown in the Share inspector and exported with your clip 
or project.
Fields that are shown 
in the Share inspector 
have a checkmark.
• To remove an attribute field: Choose the field name (so that there’s no checkmark next to it).
• To show only the Final Cut Pro default attribute fields: Choose Show Default Fields. 
Choosing this option displays only the Title, Description, Creator, and Tags fields.
Important: The default fields cannot be removed.
• To save the selected attribute fields as your default set: Choose Save as Default.
• To display your default set of attribute fields: Choose Update to Default.
Modify attributes automatically displayed in a Share inspector field
You can set the attributes that appear automatically in an attribute field.
1 In the Share inspector, choose Edit Share Fields from the Attributes pop-up menu.
2 In the Edit Share Fields window, select an attribute field from the list on the left. 
The attributes assigned to the selected field appear in the Format field. 
Select an attribute field. Format field
Options for the field appear 
in the middle of the window.Chapter 14 Share your project 386
3 To edit the selected attribute field, do any of the following:
• To add an attribute: Drag an attribute (a word or phrase in a blue bubble) from the middle of 
the window to the Format field. You can also type the attribute name in the field. 
• To add text: Type a word or phrase in the Format field at the top of the window.
• To create a custom name attribute: Enter a word or phrase in the Custom Name field at the 
bottom of the window, and drag the Custom Name attribute to the Format field.
Tip: Because the custom name attribute appears in the Format field as “Custom Name,” you 
can use it for long phrases or sentences and still easily view the other attributes and text in the 
Format field. 
• To remove an attribute or text: Select the attribute or text and press Delete. 
As you add and remove attributes, the example (below the Format field) shows your changes.
4 When you’re done, click OK. 
Export your project using Compressor
The destinations available in Final Cut Pro provide many options for exporting projects and clips. 
If you need more options, you can use Compressor, the professional transcoding application 
designed to work directly with Final Cut Pro, to create highly customized export settings. For 
example, you can use the Compressor frame resizing and retiming controls to make high-quality 
frame size and frame rate adjustments in your output files. 
Send your project to Compressor
1 Select a project in the Project Library, a clip in the Event Browser, or a range in a project or a clip. 
2 Choose File > Send to Compressor.
Note: The Send to Compressor command is dimmed if Compressor is not installed on the same 
computer as Final Cut Pro.
Compressor opens with a new batch that contains a job with the project’s or clip’s media.
3 Configure the job by adding one or more settings, and click Submit.
For more information about configuring jobs and settings, see Compressor Help at 
http://help.apple.com/compressor.Chapter 14 Share your project 387
Status ofshared projects
Shared project status overview
When you publish or share your project using any of the share options, a Share icon appears in 
the Timeline and the Project Library to indicate that the project has been published.
Share icon
Share icon
You can click the Share icon in the Project Library to open the Sharing inspector. The Sharing 
inspector displays when and where a project was published, and also provides a pop-up menu 
with additional controls for those share options that support the controls.
Click to open the shared 
item’s pop-up menu.
If you make any changes to the project, a symbol appears next to the Share icon, indicating that 
the project has changed since it was last shared. 
The icon indicates that 
the project was modified 
after it was last published.Chapter 14 Share your project 388
Visit, announce, and view the location of shared projects
You can use options in the Sharing inspector to open a project shared to a web destination, or 
send an email to announce the project. You can also locate a shared project file in the Finder. 
Click to open the shared 
item’s pop-up menu.
Open the Sharing inspector
m Click the project’s Share icon in the Project Library.
Share icon
View the project at its shared location
m In the Sharing inspector, choose Visit from the shared item’s pop-up menu.
Note: Not all shared items have a pop-up menu.
Create an email to announce a shared project
1 In the Sharing inspector, choose Tell a Friend from the shared item’s pop-up menu.
Note: Not all shared items have a pop-up menu.
2 In Mail, complete the email that was created and click Send.
The email includes a link to the published project and a subject.
Locate a shared project in the Finder
In the Sharing inspector, do one of the following:
m If the project has been shared once and only one shared item is displayed: Click the magnifying 
glass icon.
m If the project has been shared two or more times: Click Show to view the shared items, and click 
the magnifiying glass icon for the item you want to locate. 
Note: Not all shared items have a magnifiying glass icon.
For more information about shared files, see Where your media and project files are located on 
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Remove shared projects
You may find that you need to remove a shared project from its website or other final 
destination. In some cases Final Cut Pro may be able to remove it for you; in other cases you will 
have to manually remove it. In both cases, the project needs to be updated so that it no longer 
indicates that it was shared to that destination.
Remove your movie from its destination
1 Open the Sharing inspector by clicking the project’s Share icon in the Project Library.
2 In the Sharing inspector, choose Remove from the shared item’s pop-up menu.
Click to open the shared 
item’s pop-up menu.
A window appears with options for that particular share item.
Note: Not all share items have a pop-up menu.
3 Depending on the window options, do one of the following:
• To have Final Cut Pro delete the project from the destination, enter your password for the 
website you shared to, and click OK.
• Manually delete the project from the destination, and click Done.
Note: To remove a movie from CNN iReport, you need to contact the website and request the 
movie’s removal.
The shared item’s published status is removed from the project.390
Media management overview
In general, any task that relates to processing your media is considered to be media 
management. Media management includes:
• Importing media from cameras, an external storage disk, or another device. See Importing 
overview on page 19.
• Transcoding your source media files to optimized or proxy formats that are high quality and 
easy to work with. See Transcode media files on page 397.
• Backing up, consolidating, and moving projects. See Before you move or copy events and 
projects on page 402.
• Creating camera archives. See Create and manage camera archives on page 411.
• Relinking clips to media files. See Relink clips to media files on page 393.
Some of these tasks can be performed in Final Cut Pro, others can be performed in the Finder, 
and some require working in both Final Cut Pro and the Finder.
Where your media and project files are located
When you create a new event or project, folders for the new item are created in one of 
two places:
• If the new event or project is on your local system: The folders are in your Movies folder in your 
home folder (/Users/username/Movies/). This is the default location for your Final Cut Pro files.
• If the new event or project is on a connected external storage device: The folders are at the main, 
or root, level of your device.
• If the new event or project is on a storage device connected to a local network: The folders can be 
located in any folder you’ve added from a storage area network (SAN).
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When you create a new event on your local system, a folder is created for the event:
/Users/username/Movies/Final Cut Events/eventname/
The [event name] folder can contain one or more of the following items. The contents of these 
folders depend on the options you selected during import or in the Import preferences. These 
files are used and managed by Final Cut Pro, and thus should not be moved, modified, or deleted.
• Event file: Final Cut Pro event files have the name CurrentVersion.fcpevent.
• Analysis Files: This folder contains analysis files associated with the media files.
• Original Media: This folder contains either the original files that you imported from your 
camcorder or hard disk or alias files that point to the original files in another location.
• Render Files: This folder contains render files associated with the media files.
• Transcoded Media: If you chose to create optimized or proxy media, the transcoded files that 
were created are located in this folder.
• Old Versions: If you update existing events to open them with a newer version of the 
application, Final Cut Pro first saves copies of the original events in this folder.
• Backups: This folder contains a single backup copy of each event. This is a copy of 
CurrentVersion.fcpevent (the event file) only, not the associated source media files. Final Cut Pro 
updates the backup copy in 15-minute intervals (if it detects a change in the event). This 
backup copy is meant to be used by Final Cut Pro automatically in the rare instance of an 
issue when opening the event.
Similarly, when you create a Final Cut Pro project, a folder is created for the project:
/Users/username/Movies/Final Cut Projects/projectname/
The [project name] folder contains the following items. These files are used and managed by 
Final Cut Pro, and thus should not be moved, modified, or deleted.
• Project file: Final Cut Pro project files have the name CurrentVersion.fcpproject.
• Render Files: This folder contains render files associated with the project.Chapter 15 Manage media files 392
• Old Versions: If you update existing projects to open them with a newer version of the 
application, Final Cut Pro first saves copies of the original projects in this folder.
• Backups: This folder contains a single backup copy of each project. This is a copy of 
CurrentVersion.fcpproject (the project file) only, not any media files. Final Cut Pro updates the 
backup copy in 15-minute intervals (if it detects a change in the project). This backup copy is 
meant to be used by Final Cut Pro automatically in the rare instance of an issue when opening 
the project.
• Shared Items: This folder contains project files.
Tip: To quickly locate the source media file for a clip, select the clip and choose File > Reveal in 
Finder (or press Command-Shift-R).
Manage your media files
View a clip’s information
The Info inspector provides a summary of a clip’s information. Here you can view status 
information about a clip’s source media file, including the file’s location, available media 
representations for the file, the event the clip is located in, and the event the clip references.
View a clip’s information
1 Select a clip in the Event Browser or Timeline.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 Choose Show File Status from the Action pop-up menu at the bottom of the Info inspector.Chapter 15 Manage media files 393
Relink clips to media files
In Final Cut Pro, clips represent your media, but they are not the media files themselves. 
Final Cut Pro keeps track of the links between clips and media files automatically. However, there 
are times when you want to manually relink clips to media files.
One common scenario is that the media files were altered or re-created outside of your copy 
of Final Cut Pro. For example, you sent out files to be color-corrected, you’ve received the new 
versions of the files, and you want to relink the clips in your event or project to the new versions.
Another case requiring manual relinking is missing media files. For example, if you move or 
rename files in the Finder, or you move an event or a project to a different location, you need 
to relink the event or project clips (which appear as red frames with yellow alert triangles) to 
the files.
In either case, manually relinking points the clips in Final Cut Pro to the correct files on your hard 
disk. Metadata in the relinked clips remains unchanged.
The new (relinked) files can have a different resolution and codec than the original files, but 
they must be the same media type. (In other words, you can’t relink a video clip to an audio file.) 
Relinked files must also have the same frame rate and similar audio channels as the original files.
The new (relinked) files can also be trimmed versions of the original files, but they must be long 
enough to cover all the clips that refer to the files.
Because relinking event clips and relinking project clips have different effects on your events and 
projects, they are described separately below.
Relink event clips to media files
When you relink event clips to media files on your hard disk, all matched clips (including those in 
other projects or events) are updated to link to the new media files. In other words, if you used 
an event clip in multiple projects (or events), each of those projects and events is relinked to the 
new media file. If the old files are in the Original Media folder, they are moved to the Trash. You 
cannot undo this operation. 
1 In the Event Browser, select the clips you want to relink, or select an entire event in the 
Event Library.
2 Choose File > Relink Event Files.
The Relink Files window appears. By default, this window shows missing clips or events only.Chapter 15 Manage media files 394
3 If you want to show all items in the selection, select All.
4 Do one of the following:
• To locate all the matching files: Click Locate All. 
• To locate some of the matching files: Select items in the list and click Locate Selected. 
5 In the window that appears, navigate to one of the files you want to link to, or to the folder 
that contains it.
Text at the bottom of the window indicates how many potential matches to items in your 
original list were found (based on the filenames only).
Text indicates how many 
matches were found.Chapter 15 Manage media files 395
Note: Final Cut Pro identifies matches based on proximity in the directory structure and related 
filenames. For example, if your original files were in two adjacent folders, Final Cut Pro looks in 
folders adjacent to the file you chose and relinks all matching files in the relative path. If your 
original files were named “File1,” “File2,” “File3,” and so on, and you chose to relink to a file named 
“File1_A,” Final Cut Pro looks for files named “File2_A,” “File3_A,” and so on to link the remaining 
items in your list.
6 Click Choose.
Final Cut Pro analyzes the files to confirm that all attributes (in addition to the filename) match 
items in the original selection. Analysis results are shown below the Original Files list. For 
example, “3 of 3 files matched.” 
7 Click the disclosure triangle next to the analysis results to show a list of old files (on the left) and 
the new matching files (on the right).
If a file was matched incorrectly, select it in the list and press Delete. The item is placed back in 
the original list at the top of the Relink Files window.
Items with no matches remain in the original list above. You can continue to locate those by 
selecting them and repeating steps 4 through 6.
8 If you want the matching media files duplicated and placed in the Final Cut Events folder on your 
computer, select the “Copy files into Final Cut Events folder” checkbox.
9 To link the event clips to the new media files, click Relink Files.
All matched clips (including those in other projects or events) are updated to link to the new 
media files.
Relink project clips to media files
Unlike relinking event clips, relinking project clips to media files on your hard disk updates clips 
in the selected project only. New clips are added to the current project’s default event. You cannot 
undo this operation.
1 In the Timeline, select the clips you want to relink, or select a project in the Project Library.
2 Choose File > Relink Project Files.
The Relink Files window appears. By default, this window shows missing clips only.Chapter 15 Manage media files 396
3 If you want to show all items in the selection, select All.
4 Do one of the following:
• To locate all the matching files: Click Locate All. 
• To locate some of the matching files: Select items in the list and click Locate Selected. 
5 In the window that appears, navigate to one of the files you want to link to, or to the folder that 
contains it.
Text at the bottom of the window indicates how many potential matches to items in your 
original list were found (based on the filenames only).
Text indicates how many 
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Note: Final Cut Pro identifies matches based on proximity in the directory structure and related 
filenames. For example, if your original files were in two adjacent folders, Final Cut Pro looks in 
folders adjacent to the file you chose and relinks all matching files in the relative path. If your 
original files were named “File1,” “File2,” “File3,” and so on, and you chose to relink to a file named 
“File1_A,” Final Cut Pro looks for files named “File2_A,” “File3_A,” and so on to link the remaining 
items in your list.
6 Click Choose.
Final Cut Pro analyzes the files to confirm that all attributes (in addition to the filename) match 
items in the original selection. Analysis results are shown below the Original Files list. For 
example, “4 of 4 files matched.”
7 Click the disclosure triangle next to the analysis results to show a list of old files (on the left) and 
the new matching files (on the right).
If a file was matched incorrectly, select it in the list and press Delete. The item is placed back in 
the original list at the top of the Relink Files window.
Items with no matches remain in the original list above. You can continue to locate those by 
selecting them and repeating steps 4 through 6.
8 To link the project clips to the new media files, click Relink Files.
Only clips in this project are updated to link to the new media files. New clips are added to the 
project’s default event. All other events and projects remain unchanged.
Transcode media files
Final Cut Pro can play back many media formats. See Supported media formats on page 41 for a 
complete list. Final Cut Pro also provides options for transcoding your media, converting it to a 
different format or changing its settings.
• Create optimized media: This option transcodes video to the Apple ProRes 422 codec format, 
which provides better performance during editing, faster render times, and better color quality 
for compositing. If the original camera format can be edited with good performance, this 
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• Create proxy media: This option creates video and still-image proxy files. Video is transcoded to 
the Apple ProRes 422 (Proxy) codec format, which provides high-quality files useful for offline 
editing at the original frame size, frame rate, and aspect ratio. Final Cut Pro creates mediumquality (one-half resolution) proxy versions that increase editing performance. Video proxy 
files take up considerably less disk space, which often means you can work on a portable 
computer instead of a desktop computer that has significantly more memory and processing 
power. Still images are transcoded to either JPEG (if the original file doesn’t have alpha 
channel information) or PNG files (if the file has alpha channel information). Still-image proxy 
files facilitate faster processing and rendering when the original image is very large.
Note: For better import and playback performance, Final Cut Pro automatically transcodes all 
MP3 audio files to WAV audio files. When transcoding files, Final Cut Pro always retains the original 
media for future use. For more information about where to find original media, proxy media, and 
transcoded media files, see Where your media and project files are located on page 390.
You can create optimized and proxy media during the import process, or after the media has 
been imported, using the Event Browser. You can also create a proxy file for a clip using the Info 
Inspector. After the transcode is complete, the files are saved in the appropriate Event folder. See 
Where your media and project files are located on page 390 for more information.
Whether Final Cut Pro uses proxy media or your original or optimized media during playback 
is determined by the playback setting you select in the Final Cut Pro Editing preferences. See 
Modify a project’s name and properties on page 83 for more information.
Transcode media files during import
During import, Final Cut Pro either creates an alias file that points to the media file in its original 
location, or creates a copy of the original media file. After the files are imported, transcoding, 
optimization, and analysis are performed in the background.
1 Do one of the following:
• To import a file from a compatible file-based recording or storage device, or from your hard disk: 
Connect your device to your computer, turn it on, choose File > Import > Media (or press 
Command-I), navigate to and select the media you want to import, and click Import.
• To import a file from a tape-based camcorder: Connect your device to your computer, turn it on, 
and set it to VTR or VCR mode. Then choose File > Import > Media, and click Import.
• To import from an archive: Choose File > Import > Media. Select a camera archive from the list 
on the left, click Open Archive and navigate to the files you want to import, and click Import.
2 In the window that appears, choose how you want to organize the imported media in your 
Event Library:
• To add the imported media to an existing event: Select “Add to existing event,” and choose it 
from the pop-up menu.
• To create a new event: Select “Create new event” and type a name (for example, “Chris and Kim 
Wedding”) in the text field. Choose the disk where you want to store the event from the “Save 
to” pop-up menu.
To learn more about events, see Events and clips overview on page 51.
3 Select one or both of the transcode options.
Final Cut Pro will transcode the files in the background, after the import process is complete.
4 Click Import.
The import may take a while, depending on the options you chose in step 3. You can see the 
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Transcode clips after import
1 Control-click one or more clips in the Event Browser and choose Transcode Media from the 
shortcut menu.
2 In the window that appears, select the “Create optimized media” checkbox, the “Create proxy 
media” checkbox, or both, and click OK.
Note: If the original camera format can be edited with good performance, the “Create optimized 
media” option will be dimmed.
The transcoding process may take a while, depending on the options you chose in this step. 
You can see the status of all the background processes currently running in the Background 
Tasks window.
Note: MP3 audio files from projects created with versions of Final Cut Pro earlier than 10.0.4 can 
be manually transcoded to WAV audio files using this process.
Automatically transcode media files when they’re dragged into Final Cut Pro
When you drag media from the Finder into an event or Timeline in Final Cut Pro, it is 
automatically organized, transcoded, and analyzed based on the import settings that you 
set in Final Cut Pro preferences.
1 To configure the Final Cut Pro analysis options:
a Choose Final Cut Pro > Preferences.
b In the Preferences window that appears, click Import.
c Select each of the video and audio analysis options that you want to apply to your media.
d When you’re finished, close the Preferences window.
2 To import one or more files, select a file (or Command-click multiple files) in the Finder and drag 
it to an event or Timeline.
Generate a proxy file from the Info inspector
Proxy files take up considerably less disk space. In some situations, using proxy files can allow 
you to work on a portable computer instead of a desktop computer that has significantly more 
memory and processing power. You can check to see if you have a proxy file for a clip by viewing 
the clip’s information in the Info inspector. If the file you’re viewing in the Info inspector doesn’t 
have a proxy file, you’ll see a red triangle.
If a proxy has not been 
created for a clip, a red 
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You can create a proxy file for a clip by doing the following:
1 Select a clip in the Event Browser.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 Choose Show File Status from the Action pop-up menu .
4 Click the Generate Proxy button in the Available Media Representations section of the file 
status area.
The proxy file is created, and a green circle appears next to the proxy item in the Available Media 
Representations section, indicating that the proxy file for the clip is available.
View background tasks
Many Final Cut Pro tasks take place in the background:
• Importing
• Transcoding
• Video and audio optimization and analysis
• Rendering
• Sharing
Final Cut Pro manages background tasks automatically, so you don’t need to do anything to 
start or pause them. If you want to see the progress of any of the background processes, you can 
open the Background Tasks window. The tasks being performed and a percentage of completion 
are shown in the window.
Important: If you actively use Final Cut Pro while background tasks are running, the background 
tasks will pause. The tasks resume when you stop using Final Cut Pro.Chapter 15 Manage media files 401
View tasks that are running in the background
1 Do one of the following:
• Choose Window > Background Tasks (or press Command-9).
• In the toolbar, click the Background Tasks button.
2 To view the tasks that are running in each section, click a disclosure triangle.
Pause or resume a task in the Background Tasks window
m Click the Pause button or Resume button .
Cancel a task in the Background Tasks window
m Click the Cancel button .
Delete render files to free up disk space
Project and clip render files are stored in your Final Cut Events and Final Cut Projects folders. 
Over time, these files can accumulate and take up disk space. If you want to free up hard disk 
space, you can either delete unused render files or delete all of the render files for a particular 
compound clip or Final Cut Pro project.
Delete project render files
1 Select a project in the Project Library.
2 Choose File > Delete Project Render Files.
3 In the window that appears, choose to delete Unused Render Files Only or All Render Files, and 
click OK.
Delete event render files
1 Select an event in the Event Browser.
2 Choose File > Delete Event Render Files.
3 In the window that appears, choose to delete Unused Render Files Only or All Render Files, and 
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Manage your events and project files
Before you move or copy events and projects
If you want to edit a project on a different computer, or back up a project or events to an 
external storage device, you can either move or copy it. Before you move or copy a project, it’s a 
good idea to consolidate its media and back it up.
By default, media files that are imported into Final Cut Pro are not moved from their original 
location. When you import media into Final Cut Pro, you have the option to select the “Copy files 
to Final Cut Events folder” checkbox, which duplicates the source media files on your hard disk. 
Creating these copies (to be exclusively used by Final Cut Pro) can prevent you or others from 
accidentally moving files and making them unavailable to Final Cut Pro.
If a file that Final Cut Pro uses is moved, Final Cut Pro will mark the clip with a Missing File icon. If 
you think there’s a chance that media files will be moved or deleted, it’s a good idea to create a 
copy of the media.
Note: If you import files with the “Copy files to Final Cut Events folder” checkbox deselected, 
Final Cut Pro creates reference files (file aliases) that simply point to the source media files 
without copying them. When you back up or copy events and projects that use these files, 
Final Cut Pro copies the reference files only (not the source media files). If, after you back up your 
project or event, you want to replace the reference files with the actual source media files, select 
the events and choose File > Organize Event Files.
Consolidate a project’s media files
In the course of creating a project in Final Cut Pro, you might use media from a variety of 
locations, including your local computer and external storage devices. If the media used in the 
project is located on multiple hard disks, you can consolidate all the media used in the project 
on the same hard disk as the project.
Collect a project’s clips in one location
1 Locate the project you want to consolidate in the Project Library.
2 Control-click the project to select it, and choose Consolidate Project Media from the 
shortcut menu.
If a window appears stating that there is nothing to consolidate, all of your media files are 
already consolidated and located on one disk.
3 Select an option to specify how the consolidation will occur:
• Copy Referenced Events: Duplicates the referenced events (and all the clips in those events) to 
the location of your project. You may want to select this option if you use the same media in 
multiple projects, or if you haven’t finished adding clips from the event to your project.
• Move Referenced Events: Moves all the referenced events to the location of your project. If there 
are other projects that use the clips in the event you’re consolidating, those projects will not 
have access to the event. You may want to select this option if the clips in the event are only 
used in the project you’re consolidating.
• Copy Used Clips Only: Duplicates only those media files used in the project. This option gives 
you only the media used in the project (and not all the clips in the events referenced by the 
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• New Event Name field: If you select Copy Used Clips Only, you can create a new event to hold 
the consolidated media. If you don’t specify a new event name, the event will be given the 
project name.
4 Click OK.
Final Cut Pro consolidates the media using the method you selected. The event or events appear 
on the same hard disk as the project.
You can also use the Organize Event Files command to copy all external media files used by an 
event to its event folder. For more information, see Organize files while importing on page 37.
Back up projects, your Project Library, and events
Backing up your individual projects, your Project Library, and events should be an essential 
part of your workflow. Some people back up daily or weekly; others back up when a project is 
complete. To protect your media, it is recommended that you back up to a storage device or 
partition different from the one where you store the media files used with Final Cut Pro.
Note: Final Cut Pro maintains a single backup copy of each event and each project. These 
are copies of the current event and project files only, not the associated source media files. 
Final Cut Pro updates these backup copies every 15 minutes if it detects a change in an event or 
a project. For more information, see Where your media and project files are located on page 390.
Back up your project in Final Cut Pro
1 Connect an external storage device large enough to hold your project and media files and verify 
that the device appears in the Finder.
2 Control-click your project in the Project Library, and choose Duplicate Project from the 
shortcut menu.
3 In the window that appears, type a name for the new (duplicate) project and choose your 
external storage device from the Location pop-up menu.
4 Select an option to specify what is duplicated:
• Duplicate Project Only: Duplicates files specific to the project you selected. You may want to 
select this option if you use the same clips in multiple projects and plan to back up your 
events separately (perhaps in your backup copy of your entire Project Library and events). This 
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• Duplicate Project and Referenced Events: Duplicates the project and any events referred to by 
the project. Selecting this option includes all of the media in the referenced events. This is a 
good option to select if you want to have the unused media available to use later.
• Duplicate Project + Used Clips: Duplicates the project and clips used in the project. When you 
select this option, you can choose whether to copy all clips and their media or just multicam 
and compound clips, without the associated media. The first method creates a backup copy 
of your project with all of its media; the second method backs up the project and creates 
independent versions of multicam and compound clips that won’t be changed when you 
update the original versions in your project.
• All used clips: Duplicates the project and copies all clips and media used in the project to a 
new event. When you select this option, provide a name for the new event that is created.
Selecting this option duplicates the entire original media file for any clip used in the project, 
not just the portion that appears in the Timeline. If files used in the project were imported as 
reference files (aliases pointing to media files stored outside the Final Cut Events folder), the 
reference files are copied, not the original media files.
• Multicam and compound clips only: Duplicates the project and creates new parent clips for 
multicam or compound clips in the project. This means that the backup versions of the 
multicam and compound clips are not linked to the original parent versions and will not be 
updated when the original parent versions change. This option allows you to save a version 
of a project and prevent accidental changes to multicam or compound clips in that version. 
This option does not duplicate media and therefore makes a more compact backup file set 
that saves storage space. You can provide a name for a new event to hold the multicam 
or compound clips, or you can choose an existing event from the Event pop-up menu. For 
more information about multicam and compound clips, see Compound clips overview on 
page 257 and Multicam editing overview on page 308.
This option is available only if your project contains multicam or compound clips.
5 If you want to include render files (so that Final Cut Pro doesn’t have to create new ones), select 
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6 Click OK.
Final Cut Pro duplicates the project using the option you specified. The project is given an 
incremented name (for example, “Bill’s movie1”), and the project appears in the location 
you specified.
In most situations, viewing your backup projects and events is as simple as connecting your 
storage device to Final Cut Pro and locating your backup project or event in the Project Library. 
For more information about locating or viewing your project, see Common media management 
issues on page 416.
Back up your Project Library and events using the Finder
To create a single backup copy of your Project Library and events, you can copy the Final Cut 
Projects folder and Final Cut Events folder to an external storage device.
If you are backing up incrementally, create a folder structure that helps you easily navigate 
through your backup folders. You could label the folders with the date you made the backup 
copy, for example.
Important: To avoid issues, it’s essential that you place the backup files in a folder (named “2012 
Final Cut Pro Backups,” for example) that is not at the root level of your external storage device. 
1 In the Finder, locate and select your Final Cut Projects folder and Final Cut Events folder.
Your Movies folder is the default location for all project and event files:
/Users/username/Movies/
Important: If you moved a project or event after you created it, it will not be in the 
default location.
2 Drag the Final Cut Projects and Final Cut Events folders to the external storage device.
The folders are copied to your external storage device.
To restore events and projects that you backed up using the Finder, copy them back to their 
original location in the Final Cut Projects folder and Final Cut Events folder.
Note: When you import media into Final Cut Pro, you have the option to select the “Copy files to 
Final Cut Events folder” checkbox, which duplicates the source media files on your hard disk. If 
you import files with this checkbox deselected, Final Cut Pro creates reference files (file aliases) 
that simply point to the source media files without copying them. When you back up events and 
projects that use these files, Final Cut Pro copies the reference files only (not the source media 
files). If, after you back up your project or event, you want to replace the reference files with the 
actual source media files, select the events and choose File > Organize Event Files.Chapter 15 Manage media files 406
Edit your project on a different computer
If you find yourself in a situation where you need to work on your project and media files on a 
different computer, you have a variety of options:
• Move the project: You can delete the project from its current location and put it in a new 
location. When you move a project, you can move all of the events used in the project, all of 
the clips used in the project, or just the project.
• Copy the project: You can duplicate the project and put the copy in a new location. When you 
copy a project, you can copy all of the events used in the project, all of the clips used in the 
project, or just the project.
• Store projects and events on a SAN location: You can store files on a storage area network (SAN) 
location and then access them from the other computer over the network.
Note: If you have customized any Final Cut Pro effects, transitions, titles, generators or themes, 
you must manually back up and move the Motion Templates folder located in ~/Movies/
Motion Templates.
Move a project and its referenced events to another computer
1 Connect your external storage device to the computer where your Final Cut Pro project file is 
located, and verify that the device appears in the Finder.
2 Verify that Final Cut Pro is installed on the computer to which you’re moving the files.
3 On the computer where your Final Cut Pro project file is located, select your project in the 
Project Library.
4 Choose File > Move Project. 
5 In the window that appears, do the following: 
a Choose your external storage device from the Location pop-up menu.
b Select “Move Project and Referenced Events.”
Selecting this option moves the project file and any events (and all the clips in the event) 
referenced by the project file to the disk you chose in the Location pop-up menu.
For more information about the options in this window, see Organize projects in the Project 
Library on page 86.
c Click OK.
The project icon and events disappear from their current location in the Project Library 
and Event Library and appear under the storage device icon (indicating that they have 
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6 Quit Final Cut Pro, and disconnect the storage device from your computer.
WARNING: Do not disconnect a device when Final Cut Pro is using it.
7 Connect the storage device to the computer to which you want to move your project, and verify 
that the device appears in the Finder.
8 Open Final Cut Pro, and then open the Project Library.
The project you moved appears in the Project Library, listed under the connected storage device.
Note: If the storage device does not appear in the Project Library, see Common media 
management issues on page 416.
9 To move the project off the storage device to the new computer, select the project and choose 
File > Move Project.
10 In the window that appears, do the following:
a Choose the new computer from the Location pop-up menu.
b Select “Move Project and Referenced Events.”
c Click OK.
The project icon and events disappear from the external storage device and appear under the 
startup disk (home icon) in the Project Library, and the event that contains the project’s media 
appears under the startup disk (home icon) in the Event Library.
Copy a project and its clips to another computer
1 Connect your external storage device to the computer where your Final Cut Pro project file is 
located, and verify that the device appears in the Finder.
2 Verify that Final Cut Pro is installed on the computer to which you’re copying the files.
3 On the computer where your Final Cut Pro project file is located, select your project in the 
Project Library.
4 Control-click your project, and choose Duplicate Project from the shortcut menu.Chapter 15 Manage media files 408
5 In the window that appears, do the following:
a Choose your external storage device from the Location pop-up menu.
b Select Duplicate Project + Used Clips Only.
Selecting this option copies the project file and the media files used by the project file.
For more information about the options in this window, see Organize projects in the Project 
Library on page 86.
c Type a descriptive name in the New Event Name field.
If you don’t create a new name for the new event, it will be given the same name as 
your project.
d Click OK.
The project icon and events appear under the storage device icon (indicating that they have 
been copied and moved to the new location).
6 Quit Final Cut Pro, and then disconnect the storage device from your computer.
Note: You cannot disconnect a device when Final Cut Pro is using it.
7 Connect the storage device to the computer to which you want to move your project, and verify 
that the device appears in the Finder.
8 Open Final Cut Pro, and open the Project Library.
The project you copied appears in the Project Library, listed under the connected storage device.
Note: If the storage device does not appear in the Project Library, see Common media 
management issues on page 416.
9 To copy the project and media files from the storage device to the new computer, drag the 
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10 In the window that appears, do the following:
a Choose the new computer from the Location pop-up menu.
b Select “Duplicate Project and Referenced Events.”
c Click OK.
The project appears under the the startup disk (home icon) in the Project Library, and the event 
that contains the project’s media appears under the startup disk (home icon) in the Event Library.
You can now locate your project in the Project Library and begin editing. Any changes will be 
saved to the copy on the startup disk of the new computer.
If you see a Missing Media, Missing Project, or other warning icon, or if you can’t find your project 
in the Final Cut Pro Project Library, go through the steps in the task to verify that you performed 
the task correctly. For more information, see Common media management issues on page 416.
Use a SAN location to edit your project on a different computer
You can start editing a project over a network using a SAN location and then continue working 
on the project from a different computer using the same SAN location. To make the SAN location 
available to other computers on the network, you use the Remove command to disconnect the 
SAN location from the original computer. 
1 Follow the steps for adding a SAN location in Use SAN locations for events and projects on 
page 410.
2 Create a project on the SAN location, or copy or move your project to the SAN location.
3 To remove the SAN location and make it available to other computers on the network, select the 
SAN location in the Event Library or the Project Library, and choose File > Remove SAN Location.
The SAN location disappears from Event Library and the Project Library.
4 To access the SAN location on the other computer, follow the steps for adding a SAN location in 
Use SAN locations for events and projects on page 410.
Make sure to navigate to the same folder you used in step 1.
The SAN location appears as a storage location in the Event Library and the Project Library on 
the second computer. You can now use this computer to edit any events and projects stored on 
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Use SAN locations for events and projects
You can store your events and projects on a storage area network (SAN). These network storage 
locations give you more options for storing your media and streamlining your workflow over a 
high-speed local network. 
Although you can access SAN locations from different computers on a network, only one 
installed copy of Final Cut Pro can use a SAN location at a time. If you have events or projects 
stored on a SAN location, you must remove the location in Final Cut Pro to make it available to 
other computers on the network.
The SAN location feature requires a SAN volume, such as an Xsan volume connected using the 
Fibre Channel Protocol (FCP).
Add a SAN location
1 Choose File > Add SAN Location.
2 In the window that appears, navigate to a folder on a network-connected computer or 
storage device.
The folder you selected appears as a storage location in the Event Library and the Project Library.
SAN location 
on your network
Use the SAN location as you would any other storage device that appears in the Event Library 
and the Project Library. For example, you can create events or projects on the SAN location. You 
can also copy and move events or projects to the SAN location.
Remove a SAN location
1 In the Event Library or the Project Library, select the SAN location you want to remove.
2 Choose File > Remove SAN Location.
The SAN location disappears from Event Library and the Project Library. The SAN location, 
and any events or projects stored there, are now available to other Final Cut Pro users on 
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Create and manage camera archives
You can make a camera archive (backup copy) of the contents of your camera or camcorder. 
(Note that you cannot make an archive from a live video signal, such as the signal produced by 
an iSight camera.) To protect your media, it is recommended that you save your archive to a disk 
or partition different from the one where you store the media files used with Final Cut Pro.
Because you can import media into Final Cut Pro from an archive, archiving the media on your 
device can be useful if you want to:
• Quickly empty the contents of your camera or camcorder so that you can record more media 
right away, rather than wait for it to import into Final Cut Pro, which can take time.
• Import the archived media on multiple computers without having to keep it on the camcorder
• Keep a browsable, “near-line” archive of media from a camera without having to import the 
media into Final Cut Pro
See Access media on an archive or disk image on page 36 for information on how to import 
media into Final Cut Pro from a camera archive.
Archive the media on your file-based camera or camcorder
1 If you want to save the archive to an external storage device, connect it to your computer.
2 Connect the camera or camcorder to your computer using the cable that came with it, and turn 
it on.
If you’re using a camcorder, set it to PC Connect mode. The name of this transfer mode may be 
different on your device. Your camcorder may automatically go into “connect” mode if you turn 
it on in playback mode while it’s connected to your computer. For more information, see the 
documentation that came with your camcorder.
Note: Connecting a DVD camcorder to your Mac can cause the DVD Player application to open. If 
that happens, simply close DVD Player.
3 In Final Cut Pro, click the Import Media button on the left end of the toolbar (or press 
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4 In the Media Import window that appears, select the device whose content you want to archive 
from the list of cameras on the left.
Change the way clips appear 
using these controls.
The media on the 
device appears here.
Playback controls
5 Click the Create Archive button at the bottom-left corner of the window.
6 In the “Create Camera Archive as” field, type a name for the archive.
7 Choose a location to save the archive from the Destination pop-up menu, and click OK.
Note: It is recommended that you save your archive to a disk or partition different from the one 
where you store the media files used with Final Cut Pro.
The camera archive is stored on your hard disk. You can mount the archive as if it were a filebased camcorder and browse the archive’s contents, or import the media on the camera archive 
into Final Cut Pro. For more information, see Access media on an archive or disk image on 
page 36.
Note: Whenever the disk containing the archive is connected, the disk will automatically appear 
in the Camera Archives list in Final Cut Pro.
Archive the media on your tape-based camera or camcorder
1 If you want to save the archive to an external storage device, connect it to your computer.
2 Connect the camera or camcorder to your computer using the cable that came with it, and turn 
it on.
If you’re using a camcorder, set it to PC Connect mode. The name of this transfer mode may be 
different on your device. Your camcorder may automatically go into “connect” mode if you turn 
it on in playback mode while it’s connected to your computer. For more information, see the 
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3 In Final Cut Pro, do one of the following:
• Choose File > Import > Media (or press Command-I).
• Click the Import Media button on the left end of the toolbar.
4 In the Media Import window that appears, select the device whose content you want to archive 
from the list of cameras on the left.
5 Click the Create Archive button at the bottom-left corner of the window.
6 In the “Create Camera Archive as” field, type a name for the archive.
7 Choose a location to save the archive from the Destination pop-up menu, and click OK.
Note: To protect your media, it is recommended that you save your archive to a disk or partition 
different from the one where you store the media files used with Final Cut Pro.
Final Cut Pro begins archiving from the current location on the tape. It will continue to archive 
until one of the following occurs:
• It reaches the end of the tape.
• You manually stop the archiving process by clicking Stop Import or Close (to close the Media 
Import window).
The camera archive is stored on your hard disk. You can mount the archive as if it were a filebased camcorder and browse the archive’s contents, or import the media on the camera archive 
into Final Cut Pro. For more information, see Access media on an archive or disk image on 
page 36.
Whenever the disk containing the archive is connected, the disk will automatically appear in the 
Camera Archives list in Final Cut Pro as long as the archive is in one of two locations: 
• /Users/username/Movies/Final Cut Camera Archives/
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Move or copy a camera archive
1 In the Finder, select the camera archive that you want to move or copy.
2 Do one of the following: 
• To move the camera archive on your local disk: Drag the camera archive to a new location.
• To copy the camera archive on your local disk: Hold down the Option key and drag the camera 
archive to a new location on your local disk.
• To copy the camera archive to an external storage device: Drag the camera archive to a location 
on the external storage device.
Delete a camera archive
Camera archives are very small relative to other media files, and often don’t warrant being 
deleted. However, you can delete a camera archive at any time.
1 In the Finder, select the camera archive.
2 Hold down the Control key and choose Move to Trash from the shortcut menu that appears.
3 Control-click or click and hold the Trash icon in your Dock, and choose Empty Trash from the 
shortcut menu.
Important: Emptying the Trash permanently deletes the camera archive.
Solutionsto common media managementissues
Alert icons
When you see red frames and a yellow alert triangle in a Timeline or event, Final Cut Pro is 
alerting you that part of your project or event is missing. There are many reasons that clips and 
events, media files, and effects can be missing: moving projects and events between computers 
and actively managing your Final Cut Pro events or Projects folder using the Finder are two 
common reasons.
For more information about where events, clips, projects, and files are located, see Where your 
media and project files are located on page 390.Chapter 15 Manage media files 415
Icon Alert Description
Final Cut Pro events and clips
Missing event The Event folder is not available.
You may see this alert if you 
moved the event to the Trash, 
moved the event to another 
location, moved a project to 
another location, or consolidated 
a different project’s media.
Missing Clip A clip used in a Final Cut Pro 
project or in an event is 
not available.
You may see this alert if you moved 
the clip to the Trash, moved a clip 
(or event), moved a project to a 
different location, or consolidated a 
different project’s media.
Missing Camera A camera that contains files used 
in Final Cut Pro is not connected to 
your system.
To avoid getting this alert, create 
a copy of the media when you 
import it. See Organize files while 
importing on page 37 for more 
information.
Media files
Missing File A file is not available in the Finder.
You may see this alert if you moved 
or renamed a file in the Finder, 
moved an event or project to a 
different location, or consolidated 
a different project’s media.
Modified File A media file has been changed 
by an application other than 
Final Cut Pro.
Missing Proxy File A proxy file created by 
Final Cut Pro is not in its 
expected location in the Finder.
See Transcode media files on 
page 397 for more information.
Final Cut Pro effects
Missing Effect An effect in Final Cut Pro 
is missing.
Missing Generator A generator in Final Cut Pro 
is missing.
Missing Title A title in Final Cut Pro is missing.
Missing Transition A transition in Final Cut Pro 
is missing.Chapter 15 Manage media files 416
Common media management issues
This section describes common media management issues and solutions. 
If you don’t see a project on an external storage device
m Make sure the Final Cut Projects folder and the Final Cut Events folder are at the root level of the 
storage device.
m If the storage device still does not appear in the Project Library device list, you can manually 
copy or move the Final Cut Projects folder and the Final Cut Events folder to the Movies folder.
m You can also manually add individual project folders or Events folders to any existing 
Final Cut Projects folder and the Final Cut Events folder.
For more information, see Media management overview on page 390.
If you import a file directly from a hard drive and change the name in the Finder
You may see a missing file alert if you move or rename a file in the Finder. 
m In the Finder, change the filename back to the filename used in the Event Browser.
If you cancelled an import
If you cancelled an import and didn’t import an entire clip, the clip will have a Camera icon on its 
bottom-left corner.
Camera icon
m Follow the instructions in “Reimport a clip” in Import from file-based cameras on page 20.
If your computer loses power while Final Cut Pro is performing media management tasks
Because Final Cut Pro automatically saves all the changes you make as you work on a project, 
your project will be current when you restart Final Cut Pro after an unexpected power loss. If 
Final Cut Pro was performing media management tasks in the background, you can restart those 
processes manually using the Organize Event Files and Organize Project Files commands. 
1 Select one or more events in the Event Library or a project in the Project Library.
2 Do one of the following:
• To restart background media management tasks for a selected event: Choose File > Organize 
Event Files.
• To restart background media management tasks for a selected project: Choose File > Organize 
Project Files.
If your DSLR camera isn’t recognized by Final Cut Pro
m Follow the instructions in Import from a digital still camera on page 28.417
Preferences and metadata overview
In Final Cut Pro, you can modify preference settings to specify how your source media is 
imported into the application, how your clips play back, and how you edit your clips in 
the Timeline.
You can also view and change the information associated with a clip, referred to as a clip’s 
metadata. Metadata includes information about a clip’s source media files as well as information 
you add to a clip, such as notes. For more information, see Display and change clip metadata on 
page 432.
Final Cut Pro preferences
Change preference settings
A preference modifies how a particular Final Cut Pro feature behaves. Most preference settings 
can be turned on or off at any time. The following sections describe Final Cut Pro preferences 
in detail.
Open Final Cut Pro preferences
m Choose Final Cut Pro > Preferences (or press Command-Comma), and click a pane’s button at the 
top of the window to open it.
Copy Final Cut Pro preferences between computers
You can copy Final Cut Pro preference settings to another Mac that has Final Cut Pro installed so 
that the settings are the same on both computers.
1 Find the preference settings file in the following location:
/Users/username/Library/Preferences/com.apple.FinalCut.plist
2 Copy the preference settings file to the same location on another Mac.
If necessary, overwrite any existing version of the file at that location.
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Editing preferences
Editing preferences affect editing behaviors in Final Cut Pro.
Time Display
• Time Display:Use this pop-up menu to choose the time mode for Final Cut Pro. Changes in 
this setting affect the time display (for the position of the skimmer or the playhead) in the 
Dashboard in the center of the toolbar, as well as trimming and navigation operations in 
Final Cut Pro. You have the following options:
• Timecode display
• Timecode display including subframes
• Duration in frames
• Duration in seconds
Timeline
• Show detailed trimming feedback:Select this checkbox to show the “two-up” display in the 
Viewer for more accurate feedback on an edit point involving two contiguous clips. For 
example, for a simple ripple or roll edit, this display shows the end point of the left clip and the 
start point of the right clip.
• Position playhead after edit operation:Select this checkbox to have the playhead automatically 
positioned in the Timeline at the end of your last edit. For example, if you insert a clip between 
two clips in the Timeline, the playhead is automatically positioned between the inserted clip 
and the clip that follows it.
Inspector Units
• Inspector Units:Use this pop-up menu to choose how values are displayed in inspector controls 
for Transform, Crop, and Distort effects.
• Pixels:Choose this setting to display values as pixels.
• Percentages:Choose this setting to display values as percentages.
Audio
• Show reference waveforms:Select this checkbox to change the background appearance of 
the audio portion of a clip to show reference waveforms. A reference waveform shows the 
maximum visual resolution possible of the actual audio waveform. By factoring out loudness, 
reference waveforms let you see the shape of the sound more clearly. When the actual 
waveform changes shape (for example, it is diminished when a clip’s volume level is low), you 
can continue to see its reference waveform in full for easy reference when editing.Chapter 16 Preferences and metadata 419
Still Images
• Editing duration is x seconds:Use this value slider to set the default editing duration of stillimage and freeze-frame clips in seconds.
Transitions
• Duration is x seconds: Use this value slider to set the default duration of transitions in seconds.
Dialog Warnings
• Reset All:Click this button to reset all warning dialogs.
Playback preferences
Playback preferences affect playback and rendering performance in Final Cut Pro.
Rendering
• Background render:Select this checkbox to turn on Final Cut Pro rendering operations when 
the system is idle.
• Start after:Use this value slider to set the amount of time your system is idle, in seconds, before 
Final Cut Pro begins background rendering.
Playback
• Use proxy media:Click this button to use medium-quality proxy media (converted to one-half 
resolution) rather than full-resolution media for playback. Choosing this option increases 
playback performance, but the video quality is lower. In Final Cut Pro, proxy media is in the 
Apple ProRes 422 (Proxy) format. 
• Use original or optimized media:Click this button to use the optimized media for playback. 
If optimized media is not available, Final Cut Pro uses the original media for playback. In 
that case, use the Playback Quality pop-up menu to choose whether to always use the 
highest-quality video for playback or downsized video for better playback performance. In 
Final Cut Pro, optimized media is in the Apple ProRes 422 format.
• Playback Quality:Choose High Quality from this pop-up menu to prioritize high quality, or 
choose Better Performance to prioritize better performance.
• Create optimized media for multicam clips: Select this checkbox to automatically transcode 
multicam clip video to the Apple ProRes 422 codec, which provides better performance during 
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• Warn when dropping frames during playback:Select this checkbox to have Final Cut Pro warn 
you when frames are dropped during playback.
• Warn when frames are dropped due to hard disk performance:Select this checkbox to have 
Final Cut Pro warn you when frames are dropped during playback specifically because of hard 
disk performance.
Pre-Roll Duration
• Pre-Roll Duration:Use this value slider to set the amount of time to play before an audition or 
before the skimmer or playhead position when using the Play Around command.
Post-Roll Duration
• Post-Roll Duration:Use this value slider to set the amount of time to play after an audition or 
after the skimmer or playhead position when using the Play Around command.
Player Background
• Player Background:Use this pop-up menu to choose a background for the Viewer. The color 
you choose will be visible in the case of partially or completely transparent clips, or clips that 
do not fill the frame completely.
A/V Output
• A/V Output: Use this pop-up menu to choose an external audio/video device or monitor for 
output. A/V output requires third-party video interface hardware and software and is available 
only with OS X Lion v10.7.2 or later. For more information, see View playback on an external 
video monitor on page 79.
Import preferences
When you import media into Final Cut Pro using the Media Import window, you can customize 
your import settings each time you import files. However, if you drag media directly from the 
Finder into Final Cut Pro, Final Cut Pro uses the import settings you selected in the Import pane 
of the Final Cut Pro Preferences window.
Organizing
• Copy files to Final Cut Pro Events folder:Duplicates the media files and places the copy in the 
Final Cut Events folder on your system. If you’re importing media from a different disk or 
volume, or if you want to keep a copy of all the media files that have been imported into 
Final Cut Pro in the same location, select this checkbox.Chapter 16 Preferences and metadata 421
• Import folders as Keyword Collections: Creates a Keyword Collection for each folder in the files 
you’re importing. If the files you’re importing are in folders with meaningful names, select this 
option to keep the file organization that exists in the Finder. (Note that although Keyword 
Collections are not nested in the Event Library, every file in a folder will get a Keyword 
Collection for each folder it is in, whether it is one, two, or more levels deep in that folder.)
Transcoding
• Create optimized media: This option transcodes video to the Apple ProRes 422 codec, which 
provides better performance during editing, faster render times, and better color quality for 
compositing. If the original camera format can be edited with good performance, this option 
is dimmed.
• Create proxy media: This option transcodes video to the Apple ProRes 422 (Proxy) codec, which 
provides high-quality files useful for offline editing. Video proxy files can use considerably less 
disk space, often enough to allow you to work on a portable computer instead of a desktop 
computer that has significantly more memory and processing power. This option transcodes 
still images to either JPEG files (if the original file doesn’t have alpha channel information) or 
PNG files (if the file has alpha channel information).
Note: When transcoding files, Final Cut Pro always retains the original media for future use. 
For more information about where to find original media, proxy media, and transcoded media 
files, see Where your media and project files are located on page 390.
Video
• Analyze for balance color: Analyzes clips with video and detects color cast and contrast issues. 
Color is automatically balanced when you drag the clip to the Timeline. You can fix color 
balance for a clip in an event by turning on Balance in the Color section of the Video inspector.
You can turn off the automatic color adjustments at any time. After you do so, the clip has the 
colors originally recorded within the project.
• Find people: Analyzes clips with video for the presence of people and shot types. After analysis, 
any of the following keywords are added to the clip: One Person, Two Persons, Group, Close Up 
Shot, Medium Shot, and Wide Shot. The “Consolidate find people results” checkbox simplifies 
and summarizes all of the “find people” analysis keywords. For more information, see Video and 
still-image analysis options on page 45. If you’re analyzing to find people, it’s recommended 
that you also select the “Create Smart Collections after analysis” checkbox.
• Create Smart Collections after analysis: Creates Smart Collections for each keyword applied 
when video clips are analyzed for image stabilization problems or the presence of people. The 
Smart Collections appear inside a folder inside the event.
Audio
• Analyze and fix audio problems: Analyzes audio and automatically corrects it for hum, noise, and 
loudness. You can turn off automatic audio corrections at any time; after you do so, the audio 
will play as originally recorded.
• Separate mono and group stereo audio: Analyzes and groups audio channels as dual mono or 
stereo, depending on the results of the analysis. For more information about audio channels, 
see Configure audio channels on page 169.
• Remove silent channels: Audio channels are analyzed, and silent channels are 
automatically removed.
Note: You can retrieve the original audio configuration after import. See Configure audio 
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Destinations preferences
You modify share destinations in the Destinations pane of the Final Cut Pro Preferences window. 
The destinations in the Destinations list (on the left side of the Destinations pane) also appear in 
the Share submenu of the File menu and in the pop-up menu that appears when you click the 
Share button in the toolbar.
When you first open Final Cut Pro, a default set of destinations appears in the Destinations list, 
but you can add other destinations and customize destinations. To see the destinations you 
can add, select Add Destination in the Destinations list. When you select a destination in the 
Destinations list, its settings appear on the right. 
The settings available for each destination are described below. For information about adding 
and modifying destinations, see Work with destinations on page 427.
DVD and Blu-ray
Use these destinations to burn your project or clip to a standard-definition (SD) DVD or a Blu-raycompatible disc, or to create a disk image (.img) file you can copy to an external drive or burn to 
disc later.
Note: The Blu-ray destination does not appear by default. To add it to the Destinations list, see 
Work with destinations on page 427.
The DVD and Blu-ray destinations include the following settings:
• Output Device: Displays your system’s suitable output devices, including optical drives and the 
computer’s hard disk.
You can use your hard disk to create a disk image (.img) file that you can copy to an external 
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• Layers: Displays the available layers on the destination media. 
• Automatic: Automatically detects the type of disc you can use.
• Single-layer: Identifies the disc as a single-layer disc. You can use this option to force a duallayer disc to be treated as a single-layer disc.
• Double-layer: Identifies the disc as a double-layer disc. You can use this option to force the 
disk image to be formatted for a double-layer disc when you choose Hard Drive as your 
output device.
Important: Depending on the project’s length, choosing Double-layer when using a singlelayer disc may result in an error while burning the disc.
• Disc template: Displays the available disc templates.
• When disc loads: Displays the automatic action taken when you play the disc.
• Show Menu: Displays the main menu.
• Play Movie: Begins playing the movie immediately.
• Markers: Not available for Blu-ray when using an AVCHD output device. Select the checkbox 
to include chapter marker text as subtitles on the output disc. Users can navigate between 
the chapter markers by pressing the Next Chapter or Previous Chapter button on the DVD or 
Blu-ray player. For more information about chapter markers, see Manage chapter markers and 
their thumbnail images on page 152.
• Loop: Available for Blu-ray only. Select this checkbox to add a loop icon to the menu.
• Background: Click the Add button to add a background graphic.
• Logo graphic: Available for Blu-ray only. Click the Add button to add a logo graphic.
• Title graphic: Available for Blu-ray only. Click the Add button to add a title graphic.
• Preview: Click Main Menu to preview the main menu; click Chapter Menu to preview the 
chapter menu. 
Email
Use this destination to email your project or clip using Mail, Apple’s email program. The Email 
destination automatically creates an email message that includes the exported file.
Note: The Email destination does not appear by default. To add it to the Destinations list, see 
Work with destinations on page 427.
The Email destination includes the following settings:
• Resolution: Choose a resolution from the pop-up menu. 
• Compression: Choose “Better quality” if you want the highest-quality compression; choose 
“Faster encode” if you’re willing to sacrifice quality for faster processing.
YouTube, Vimeo, Facebook, and CNN iReport
Use these destinations to publish your project or clip to your YouTube, Vimeo, Facebook, or CNN 
iReport account.
Note: The CNN iReport destination does not appear by default. To add it to the Destinations list, 
see Work with destinations on page 427.
Important: If you have two or more accounts for the same website, you must make a separate 
destination for each account. After you enter the account information, the destination name is 
appended with the account name in parentheses; for example, “YouTube (myusername).” If you 
want, you can rename the destination with a more descriptive name.Chapter 16 Preferences and metadata 424
The web destinations include the following settings:
• Sign In: The first time you open a new web destination, a window for entering your account 
information appears. If you enter your account name and password and select the “Remember 
this password in my keychain” checkbox, you won’t need to enter your account name or 
password again. 
After the initial setup, you can click the Sign In button in the destination’s settings to reenter 
or change your account information.
• Resolution: Choose the default resolution for the destination. If the destination is used with 
a project or clip that has a lower resolution than the resolution you chose, the resolution 
changes to match that of the project or clip.
• Compression: Choose “Better quality” if you want the highest-quality compression; choose 
“Faster encode” if you’re willing to sacrifice quality for faster processing.
• Make this movie Private: Available for YouTube only. If this checkbox is selected, only the 
contacts you specify in your YouTube account settings can see your movie.
• Category: Available for YouTube only. Choose the YouTube category your movie will appear in.
• Viewable by: Available for Facebook and Vimeo only. Choose who can view your movie.
Save Current Frame and Image Sequence
Use these destinations to save a still image of any video frame in your project or to save a set of 
sequentially numbered still-image files.
Note: The Save Current Frame and Image Sequence destinations do not appear by default. To 
add either of them to the Destinations list, see Work with destinations on page 427.
The Save Current Frame and Image Sequence destinations include the following settings:
• Export: Choose a file format for the exported file.
• Scale image to preserve aspect ratio: Select this checkbox to scale the output file to use square 
pixels and maintain the original aspect ratio (which results in an increase or decrease in the 
number of horizontal and vertical pixels). 
The checkbox affects only projects with formats that use non-square pixels, such as NTSC 
and PAL formats. If the checkbox is not selected (the default setting), the output file uses 
the same pixel aspect ratio and has the same number of horizontal and vertical pixels as the 
original video.
Export File
Note: This destination is used as the basis for three of the destinations in the default set: Master 
File, Apple Devices 720p, and Apple Devices 1080p. When you create and modify destinations in 
Final Cut Pro preferences, this destination is called Export File.
Use this destination to export your project or clip as a movie file with video and audio, as a video 
file (with no audio), or as an audio file (with no video). This destination is used to export files for 
Apple devices, computers, and web hosting. 
You can customize the Export File destination by choosing one of several resolutions, depending 
on the intended playback device. For example, choose 1280 x 720 resolution for iPhone and iPod, 
and 1920 x 1080 resolution for iPad. You can also export one or more of the roles used in your 
project into one or more files, also known as media stems.Chapter 16 Preferences and metadata 425
The Export File destination includes the following settings:
• Format: Lists mastering formats (Video and Audio, Video Only, Audio Only) and publishing 
formats (Apple Devices, Computer, Web Hosting). Your choice of format determines the 
options in the pop-up menus below.
Important: When sharing a project or clip, you can change the resolution only for 
publishing formats.
• Video codec: Choose the video codec to use for the exported file. (Available choices are based 
on the source clip or project media format.)
• Resolution: Choose the default resolution for the destination. If the destination is used with 
a project or clip that has a lower resolution than the resolution you chose, the resolution 
changes to match that of the project or clip.
• Audio file format: If you chose Audio Only from the Format pop-up menu, choose an audio 
format for the exported file. If you chose another option from the Format pop-up menu, this 
item lists the audio format that will be used for the exported file.
• Include chapter markers: Select the checkbox to include chapter markers that were added to 
the project in the output file. Users can navigate between the chapter markers by clicking the 
Next Chapter or Previous Chapter button in iTunes or QuickTime Player. 
• “When done,” “Open with,” or “Add to playlist”: Choose what should happen when the export is 
complete. You can choose to open the exported file in an application, add it to your iTunes 
library, or publish it to the Media Browser. The name of the pop-up menu changes depending 
on what you choose.
• Do Nothing: Choose this option if you don’t want to automatically open the exported file.
• QuickTime Player, iTunes, or another application: Choose this option to open the exported 
file in the default application associated with the file. You can set or change the default 
application in the Finder. For more information, see OS X Help, available from the Help menu 
when the Finder is active.
• Compressor: Choose this option to open the exported file in Compressor. The exported file 
will appear as the source in a new batch, making it easy to continue to process the project’s 
movie. For example, you can create the compressed versions needed for distribution, 
without involving Final Cut Pro.
Note: This option is available only if Compressor is installed on the same computer as 
Final Cut Pro.
• Other: Choose this option to specify another application to open the exported file. Select the 
application in the window that appears, and click Open.
• Library: Choose this option to add the exported file to your iTunes library.
• Publish to Media Browser: Choose this option to add the exported file to the Media Browser, 
making the output file available in Final Cut Pro and other Mac applications.
• Roles as: Available only if you chose a mastering format (Video and Audio, Video Only, or Audio 
Only) from the Format pop-up menu. If you need to export your project as separate media 
files (for example, if you want to export the dialogue, music, and sound effects from your 
project separately), you can export one or more of your project’s roles as media stems. You 
can create a combined, multitrack QuickTime file or separate audio or video files using your 
project’s audio and video roles, and you can assign mono, stereo, or surround output for your 
audio channels. For more information about roles, see Roles overview on page 299.Chapter 16 Preferences and metadata 426
Compressor Settings
Use this destination to export a project or clip using settings from Compressor, the professional 
transcoding application designed to work directly with Final Cut Pro. 
Note: The Compressor Settings destination does not appear by default. To add it to the 
Destinations list, see Work with destinations on page 427.
Exporting a project with a Compressor setting provides many of the benefits of Compressor 
without actually opening your project in Compressor. You can use Compressor to create multiple 
output files in one share operation, or create custom settings that modify your output file (for 
example, to add a watermark to the video). If you have Compressor installed on your system, you 
can use any of your Compressor settings with Final Cut Pro. 
If you don’t have Compressor installed on your system and you receive a Compressor setting 
from someone else, put the setting in this location so that Final Cut Pro and Compressor can 
access it: 
/Users/username/Library/Application Support/Compressor/Settings/
You may need to create the Compressor and Settings folders using Finder. 
Tip: In OS X Lion v10.7 and later, the Library folder within your home folder is hidden by default. 
You can access it in the Finder by choosing Go > Go to Folder and entering ~/Library/ in the “Go 
to the folder” field. For more information, see OS X Help, available from the Help menu when the 
Finder is active.
HTTP Live Streaming
Use this destination to send audio and video to iPhone, iPad, iPod touch, and Mac using a 
web server.
Note: The HTTP Live Streaming destination does not appear by default. To add it to the 
Destinations list, see Work with destinations on page 427.
Because HTTP live streaming dynamically adjusts movie playback quality to match 
the available speed of wired or wireless networks, it’s a great way to deliver streaming 
media to your iOS-based app or HTML5-based website. For detailed information about 
implementing HTTP live streaming, see the Apple Developer HTTP Live Streaming website at 
http://developer.apple.com/resources/http-streaming.
The HTTP Live Streaming destination includes the following setting:
• Versions to export: Select the checkbox for each type of network connection you want to 
support for streaming. You can export files for use with devices that use cellular, Wi-Fi, and 
broadband data connections.
Bundle
You can group sets of destinations together in a bundle to create several types of output in a 
single step. When you share a project or clip using the bundle, a file for each destination in the 
bundle is output automatically. To learn how to create a bundle, see Work with destinations on 
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Work with destinations
You modify share destinations using the Destinations pane of the Final Cut Pro Preferences 
window. You can modify existing destinations, add new destinations, delete destinations, and 
create destination bundles, which allow you to export multiple types of output at once. You 
can also revert to the default set of destinations that were available when you first opened 
Final Cut Pro. 
For information about sharing projects and clips from Final Cut Pro, see Sharing projects 
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Create a new destination
1 Do one of the following:
• Choose File > Share > Add Destination.
• Choose Final Cut Pro > Preferences, click the Destinations button at the top of the window, 
and select Add Destination in the Destinations list on the left.
• Select a clip or project, click the Share button in the toolbar, and choose Add Destination from 
the pop-up menu.
2 In the Destinations pane of the Preferences window, do one of the following:
• Drag a destination from the area on the right to the Destinations list on the left (or doubleclick a destination on the right).
Drag a destination 
Destinations list to the Destinations list.
• Control-click a destination in the Destinations list and choose Duplicate from the 
shortcut menu.
The new destination appears selected in the list on the left, and the settings for the destination 
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3 Choose the settings you want for the new destination. 
Modify the settings for 
New destination the new destination.
If you chose a web destination, enter your user name and password in the window that 
appears, and click OK. If you select the “Remember this password in my keychain” checkbox, 
your user name and password are saved so that your exported file can be uploaded to the 
website automatically.
If you chose the Compressor Settings destination, select a Compressor setting in the window 
that appears, and click OK. The settings that are displayed include the Compressor settings that 
come with Final Cut Pro as well as any settings you added.
Important: You can use the Compressor Settings destination only if you have Compressor 
installed or someone gives you a Compressor setting.
For details about the settings for each destination, see Destinations preferences on page 422.
At any time, you can double-click the destination in the Destinations list to type a new name 
or use the controls on the right to change the destination settings. As you customize the 
destination, your changes are saved automatically.Chapter 16 Preferences and metadata 430
Modify existing destinations
Note: You can also modify an existing destination’s settings while you’re sharing a project or clip. 
For more information, see Share projects, clips, and ranges on page 378.
1 Choose Final Cut Pro > Preferences, and click Destinations.
The Destinations pane appears, with a list of destinations on the left.
2 Do any of the following: 
• To change a destination’s settings: Select a destination, and modify the destination’s settings on 
the right.
Modify the settings for 
the selected destination.
Select a destination 
in the Destinations list.
• To restore a destination to its original settings: Control-click a destination in the Destinations list 
and choose Revert to Original Settings from the shortcut menu.
The destination’s settings are restored to their original values and the settings are 
saved automatically.
• To rename a destination:Double-click a destination in the list on the left and type a new name.
• To change the order of destinations in the list: Drag a destination to a different location in the 
Destinations list.
As you modify destinations, your changes are saved automatically.Chapter 16 Preferences and metadata 431
Create a bundle of destinations
Bundles make it easy to create several types of output in a single step. A bundle holds a set of 
destinations. When you share a project or clip using the bundle, a file for each destination in the 
bundle is output automatically.
1 In the Destinations pane of the Preferences window, select Add Destination in the Destinations 
list and then double-click the Bundle destination (or drag it from the area on the right to the 
Destinations list on the left).
An empty bundle appears in the Destinations list.
2 To add destinations to the bundle, drag existing destinations into it from the Destinations list, or 
select Add Destination and drag destinations from the area on the right into the bundle.
Tip: To quickly make a bundle from destinations in the Destinations list, select one or more 
destinations in the Destinations list, Control-click in the Destinations list, and choose New Bundle 
from Selection from the shortcut menu.
Delete a destination
Do one of the following:
m Control-click a destination in the Destinations list, and choose Delete from the shortcut menu.
m Select a destination in the Destinations list, and press Command-Delete.
m Select a destination in the Destinations list, and click the Remove (–) button below the list.
Specify a new default destination
One destination is labeled as the default destination, and only this destination can be opened 
using a keyboard shortcut (Command-E). When you first open Final Cut Pro, the Master 
File destination is the default destination. You can easily make any other destination the 
default destination.
m Control-click the destination you want to make the default, and choose Make Default from the 
shortcut menu.
The name of the new default destination is appended with “(default).”
Revert to the default set of destinations that came with Final Cut Pro
m Control-click in the Destinations list and choose Restore Default Destinations from the 
shortcut menu.
Any custom destinations are deleted, and the default set of destinations appears. For a list of the 
default destinations, see Sharing projects overview on page 377.
Share destinations between Final Cut Pro users
m To export destinations from your copy of Final Cut Pro: Drag one or more destinations from the 
Destinations list in the Destinations pane of Final Cut Pro preferences to a location in the Finder.
The destination file is appended with the .fcpxdest extension.
m To import destinations into your copy of Final Cut Pro: Drag a destination file from a location in the 
Finder to the Destinations list.
The destination you added appears in the Destinations list, the Share submenu of the File menu, 
and the pop-up menu that appears when you click the Share button in the toolbar.Chapter 16 Preferences and metadata 432
Work with metadata
Display and change clip metadata
Information about your source media files, information recorded by the camera, and descriptive 
information about a clip are called metadata. In Final Cut Pro, you can create your own 
combinations of metadata to display with your clips, called metadata views. You can either create 
new metadata views or modify the ones that come with Final Cut Pro.
In Final Cut Pro, you work with three types of metadata:
• Exchangeable Image File (EXIF) data: Information recorded by the camera and stored in the 
media at the time it was shot, such as camera make and model, file size, color profile, and bits 
per sample.
• International Press Telecommunications Council (IPTC) data: Standardized data used by media 
organizations to embed keywords, captions, copyright notices, and other information in the 
media files themselves.
• Final Cut Pro metadata: Data you apply to clips within Final Cut Pro, such as clip name, ratings, 
and keywords.
You can use the Info inspector to view and change the metadata for a clip or group of clips 
selected in the Event Browser or Timeline. 
Info button
The Share inspector also displays metadata that is exported with a shared clip or project. For 
more information, see Modify share attributes on page 383.
View a clip’s metadata
1 Select a clip.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
Metadata for the selected clip or group of clips is displayed in fields in the Info inspector.Chapter 16 Preferences and metadata 433
Switch metadata views in the Info inspector
You can change the metadata fields shown in the Info inspector by choosing a different 
metadata view from the Metadata View pop-up menu.
1 Select a clip.
2 Open the Info inspector.
3 Choose a metadata view from the Metadata View pop-up menu.
Metadata View pop-up menu
Note: If you create custom metadata views, they also appear in the pop-up menu.
Change a clip’s metadata
1 Select a clip.
2 Open the Info inspector.
3 In the Metadata View pop-up menu, choose a metadata view that contains fields for the 
metadata you want to change.
4 Do either of the following:
• Click in a text field to make it active, and enter the text you want to include.
Note: If you can’t click in a text field, the field can’t be edited. Some EXIF metadata fields, for 
example, can’t be edited.
• Choose an option from the pop-up menu for the metadata you want to change.
Note: You can also change the Content Created date and time of your source clips in the 
Event Browser. Just select one or more clips and choose Modify > Adjust Content Created 
Date and Time.
Rearrange the fields in a metadata view
m In the Info inspector, drag the metadata labels into a different order.
Modify metadata views
You can create new metadata views or modify the ones that come with Final Cut Pro.
Create a new metadata view
1 Select a clip.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 In the Info inspector, choose Edit Metadata View from the Metadata View pop-up menu.
4 In the Metadata Views window, choose New Metadata View from the Action pop-up menu 
at the bottom-left corner of the window.
5 Enter a name for the new metadata view, and press Return.
6 To limit the number of properties to a specific group, such as EXIF or video properties, choose a 
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7 To add a property to the metadata view, select the checkbox to the left of the property.
Click a checkbox to add a 
property to the metadata view.
Action pop-up menu
8 When you are satisfied with the metadata fields assigned to the metadata view, click OK.
The new metadata view is added to the Metadata View pop-up menu in the Info inspector.
Modify an existing metadata view
You can change the combination of metadata that appears in an existing metadata view. You 
can rename metadata fields, add or remove metadata fields, create custom metadata fields, and 
rearrange the order in which the metadata fields are displayed.
1 Select a clip.
2 Open the Info inspector.
3 In the Info inspector, choose Edit Metadata View from the Metadata View pop-up menu.
4 In the Metadata Views window, select the metadata view you want to change, and do any of 
the following:
• To rename the metadata view: Double-click the metadata view name in the column on the left, 
enter a new name, and press Return.
• To remove properties (metadata fields) from the metadata view: In the Property column, click the 
checkmark to the left of the property you want to remove.
• To add properties (metadata fields) to the metadata view: In the Property column, select the 
checkbox to the left of the property you want to add.
• To add a custom property (metadata field) to the metadata view: Choose Add Custom Metadata 
Field from the Action pop-up menu , enter a name and description for the new property, 
and click OK.
5 When you are satisfied with the metadata fields assigned to the selected metadata view, click OK.Chapter 16 Preferences and metadata 435
Duplicate a metadata view
If you want to create a new metadata view that contains most of the metadata fields in an 
existing metadata view, you can save time by duplicating the existing metadata view and then 
modifying it.
1 Select a clip.
2 Open the Info inspector.
3 In the Info inspector, choose the metadata view you want to duplicate from the Metadata View 
pop-up menu, and then choose Save Metadata View As from the Metadata View pop-up menu.
4 In the window that appears at the top of the Final Cut Pro window, enter a name for the new 
metadata view and click OK.
The new metadata view appears in the Metadata View pop-up menu in the Info inspector. 
Modify the new metadata view as needed.
Delete a metadata view
1 Select a clip.
2 Open the Info inspector.
3 In the Info inspector, choose Edit Metadata View from the Metadata View pop-up menu.
4 In the Metadata Views window, select the metadata view you want to delete in the column 
on the left, and choose Delete Metadata View from the Action pop-up menu in the 
lower-left corner.
The metadata view is removed from the left column of the Metadata Views window and from 
the Metadata View pop-up menu in the Info inspector.
Note: Deleting a metadata view does not delete metadata applied to a clip or its source media.
Batch rename clips
When you import media into Final Cut Pro, the clips often contain meaningless names, such 
as those assigned by the camera. Although you can rename clips individually, you can also 
automatically rename a selection of clips as a batch (batch rename) in the Event Browser, after 
the media has been imported into Final Cut Pro. Final Cut Pro provides customizable naming 
presets that make renaming large amounts of clips efficient and easy.
Batch rename clips using a naming preset
1 In the Event Browser, select the clips you want to rename.
2 To open the Info inspector, click the Inspector button in the toolbar (shown below), and click the 
Info button at the top of the pane that appears.
3 Choose Apply Custom Name from the Action pop-up menu and choose a naming preset 
from the submenu.
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Create a new naming preset
In most cases, you’ll want to create a new naming preset and customize it.
Tip: The easiest way to create a new naming preset is to duplicate an existing one. See the 
following task for more information.
1 In the Event Browser, select the clips you want to rename.
2 Open the Info inspector.
3 Choose Apply Custom Name from the Action pop-up menu and choose New from 
the submenu.
4 In the Naming Presets window, double-click Untitled, type a name for the new preset, and 
press Return.
The new naming preset appears in the Apply Custom Name submenu of the Action 
pop-up menu.
Duplicate an existing naming preset
The simplest way to create a new naming preset is to duplicate an existing preset—one that 
contains most of the name format options you want to include—and modify it.
1 In the Event Browser, select the clips you want to rename.
2 Open the Info inspector.
3 Choose Apply Custom Name from the Action pop-up menu and choose Edit from 
the submenu.
4 In the Naming Presets window, Control-click the preset that you want to duplicate, and choose 
Duplicate from the shortcut menu.
The duplicate naming preset appears below the original preset.
5 Enter a name for the duplicate preset, and press Return.
You can now modify the preset to suit your needs.
Modify an existing naming preset
1 In the Event Browser, select the clips you want to rename.
2 Open the Info inspector.
3 Choose Apply Custom Name from the Action pop-up menu and choose Edit from 
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4 In the Naming Presets window, add name tokens by dragging the elements from the Clip Info, 
Date/Time, Format, and Camera areas to the Format field.
To remove a naming token, select it in the Format field, and press Delete.
5 Rearrange the tokens in the Format field by dragging them into new positions.
6 If you like, add text characters between naming tokens in the Format field, such as underscores 
(_) and spaces.
7 When you are satisfied with the naming preset’s new format, click OK.
Remove a naming preset
1 Select a clip.
2 Open the Info inspector.
3 Choose Apply Custom Name from the Action pop-up menu and choose Edit from 
the submenu.
4 In the Naming Presets window, select the naming preset you want to remove, and click the 
Remove Presets button (with a minus sign).
The naming preset is removed from the Naming Presets window.438
Keyboard shortcuts and Multi-Touch gestures overview
Final Cut Pro provides several ways to increase your efficiency while you put together 
your project:
• Standard keyboard shortcuts: Many common tasks, such as opening a specific window or 
adding a clip from the Event Browser to the Timeline, can be accomplished very quickly by 
pressing one or more keys. See Keyboard shortcuts on page 438.
• Multi-Touch gestures: If you have a Multi-Touch trackpad or mouse, you can take advantage of 
Multi-Touch gestures to quickly perform many tasks while creating your project. See MultiTouch gestures on page 452.
• Custom keyboard shortcuts: You can add to the standard keyboard shortcuts by creating your 
own custom keyboard shortcuts for features that you use frequently, such as Color Board 
controls. Or if you’re more familiar with keyboard shortcuts from another application, you can 
use the Command Editor to substitute those keyboard shortcuts in place of the default set in 
Final Cut Pro. See View keyboard shortcuts in the Command Editor on page 452.
Keyboard shortcuts
You can use keyboard shortcuts to quickly accomplish many tasks in Final Cut Pro. To use a 
keyboard shortcut, press all the keys in the shortcut at the same time. Shortcuts for common 
commands are listed in the table below.
Application
Command Shortcut Action
Hide Application Command-H Hide Final Cut Pro
Hide Other Applications Command-Option-H Hide all applications except 
Final Cut Pro
Keyboard Customization Command-Option-K Open the Command Editor
Minimize Command-M Minimize Final Cut Pro
Preferences Command-Comma (,) Open the Final Cut Pro 
Preferences window
Quit Command-Q Quit Final Cut Pro
Redo Change Command-Shift-Z Redo the last command 
Undo Change Command-Z Undo the last command
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Editing
Command Shortcut Action
Append to Storyline E Add the selection to the end of 
the storyline
Audition: Add to Audition Shift-Control-Y Add the selected clip to 
the audition
Audition: Duplicate and 
Paste Effects
Command-Option-Y Duplicate clips in the audition and 
add effects
Audition: Duplicate as Audition Option-Y Create an audition with a Timeline 
clip and a duplicate version of the 
clip, including applied effects
Audition: Duplicate from Original Command-Shift-Y Duplicate the selected audition 
clip without applied effects
Audition: Replace and Add 
to Audition
Shift-Y Create an audition and replace 
the Timeline clip with the 
current selection
Blade Command-B Cut the primary storyline clip (or 
the selection) at the skimmer or 
playhead location
Blade All Command-Shift-B Cut all clips at the skimmer or 
playhead location
Break Apart Clip Items Command-Shift-G Break the selected item into its 
component parts
Change Duration Control-D Change the duration of 
the selection
Connect to Primary Storyline Q Connect the selection to the 
primary storyline
Connect to Primary 
Storyline - Backtimed 
Shift-Q Connect the selection to the 
primary storyline, aligning the 
selection’s end point with the 
skimmer or playhead
Copy Command-C Copy the selection
Create Audition Command-Y Create an audition from 
the selection
Create Storyline Command-G Create a storyline from a selection 
of connected clips
Cut Command-X Cut the selection
Cut and Switch to Viewer Angle 1 1 Cut and switch the multicam clip 
to angle 1 of the current bank
Cut and Switch to Viewer Angle 2 2 Cut and switch the multicam clip 
to angle 2 of the current bank
Cut and Switch to Viewer Angle 3 3 Cut and switch the multicam clip 
to angle 3 of the current bank
Cut and Switch to Viewer Angle 4 4 Cut and switch the multicam clip 
to angle 4 of the current bank
Cut and Switch to Viewer Angle 5 5 Cut and switch the multicam clip 
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Command Shortcut Action
Cut and Switch to Viewer Angle 6 6 Cut and switch the multicam clip 
to angle 6 of the current bank
Cut and Switch to Viewer Angle 7 7 Cut and switch the multicam clip 
to angle 7 of the current bank
Cut and Switch to Viewer Angle 8 8 Cut and switch the multicam clip 
to angle 8 of the current bank
Cut and Switch to Viewer Angle 9 9 Cut and switch the multicam clip 
to angle 9 of the current bank
Delete Delete Delete the Timeline selection, 
reject the Event Browser 
selection, or remove a multicam 
through edit
Delete Selection Only Command-Option-Delete Delete the selection and attach 
the connected clip or clips to the 
resulting gap clip
Deselect All Command-Shift-A Deselect all selected items
Duplicate Command-D Duplicate the Event Browser 
selection
Enable/Disable Clip V Enable or disable playback for 
the selection
Expand Audio/Video Control-S View audio and video separately 
for selected clips
Expand/Collapse 
Audio Components 
Option-Control-S Expand or collapse audio 
components for the selection in 
the Timeline
Extend Edit Shift-X Extend the selected edit point to 
the skimmer or playhead position
Extend Selection Down Shift-Down Arrow In the Event Browser, add the next 
clip to the selection
Extend Selection Up Shift-Up Arrow In the Event Browser, add the 
previous clip to the selection
Finalize Audition Shift-Option-Y Dissolve the audition and replace 
it with the audition pick
Insert W Insert the selection at the skimmer 
or playhead position 
Insert/Connect Freeze Frame Option-F Insert a freeze frame at the 
playhead or skimmer location 
in the Timeline, or connect 
a freeze frame from the skimmer 
or playhead location in the 
event to the playhead location 
in the Timeline
Insert Gap Option-W Insert a gap clip at the skimmer or 
playhead position
Insert Placeholder Command-Option-W Insert a placeholder clip at the 
skimmer or playhead position
Lift from Storyline Command-Option-Up Arrow Lift the selection from the storyline 
and connect it to the resulting 
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Command Shortcut Action
Lower Volume 1 dB Control-Hyphen (-) Lower the audio volume by 1 dB
Move Playhead Position Control-P Move the playhead by entering a 
timecode value
New Compound Clip Option-G Create a new compound clip (if 
there’s no selection, create an 
empty compound clip)
Nudge Audio Subframe Left Option-Comma (,) Nudge the selected audio edit 
point left by one subframe, 
creating a split edit
Nudge Audio Subframe Left Many Shift-Option-Comma (,) Nudge the selected audio edit 
point left by 10 subframes, creating 
a split edit
Nudge Audio Subframe Right Option-Period (.) Nudge the selected audio edit 
point right by one subframe, 
creating a split edit
Nudge Audio Subframe 
Right Many 
Shift-Option-Period (.) Nudge the selected audio edit 
point right by 10 subframes, 
creating a split edit
Nudge Down Option-Down Arrow Nudge down the value of 
the selected keyframe in the 
Animation Editor
Nudge Left Comma (,) Nudge the selection one unit to 
the left
Nudge Left Many Shift-Comma (,) Nudge the selection 10 units to 
the left
Nudge Right Period (.) Nudge the selection one unit to 
the right
Nudge Right Many Shift-Period (.) Nudge the selection 10 units to 
the right
Nudge Up Option-Up Arrow Nudge up the value of the selected 
keyframe in the Animation Editor
Open Audition Y Open the selected audition
Override Connections Grave Accent (`) Temporarily override clip 
connections for the selection
Overwrite D Overwrite at the skimmer or 
playhead position
Overwrite - Backtimed Shift-D Overwrite from the skimmer or 
playhead position back
Overwrite to Primary Storyline Command-Option-Down Arrow Overwrite at the skimmer or 
playhead position in the primary 
storyline
Paste as Connected Option-V Paste the selection and connect it 
to the primary storyline
Paste Insert at Playhead Command-V Insert the Clipboard contents at 
the skimmer or playhead position
Previous Angle Shift-Control-Left Arrow Switch to the previous angle in the 
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Command Shortcut Action
Previous Audio Angle Shift-Option-Left Arrow Switch to the previous audio angle 
in the multicam clip
Previous Pick Control-Left Arrow Select the previous clip in the 
Audition window, making it the 
audition pick
Previous Video Angle Command-Shift-Left Arrow Switch to the previous video angle 
in the multicam clip
Raise Volume 1 dB Control-Equal Sign (=) Raise the audio volume by 1 dB
Replace Shift-R Replace the selected clip in 
the Timeline with the Event 
Browser selection
Replace from Start Option-R Replace the selected clip in 
the Timeline with the Event 
Browser selection, starting from 
its start point
Replace with Gap Shift-Delete Replace the selected Timeline clip 
with a gap clip
Select All Command-A Select all clips
Select Clip C Select the clip under the pointer in 
the Timeline
Select Left Audio Edge Shift-Left Bracket ([) For audio/video clips in expanded 
view, select the left edge of the 
audio edit point
Select Left Edge Left Bracket ([) Select the left edge of the 
edit point
Select Left and Right Audio 
Edit Edges
Shift-Backslash (\) For audio/video clips in expanded 
view, select the left and right 
edges of the audio edit point
Select Left and Right Edit Edges Backslash (\) Select the left and right edges of 
the edit point
Select Next Angle Shift-Control-Right Arrow Switch to the next angle in the 
multicam clip
Select Next Audio Angle Shift-Option-Right Arrow Switch to the next audio angle in 
the multicam clip
Select Next Pick Control-Right Arrow Select the next clip in the 
Audition window, making it 
the audition pick
Select Next Video Angle Command-Shift-Right Arrow Switch to the next video angle in 
the multicam clip
Select Right Audio Edge Shift-Right Bracket (]) For audio/video clips in expanded 
view, select the right edge of the 
audio edit point
Select Right Edge Right Bracket (]) Select the right edge of the 
edit point
Set Additional Selection End Command-Shift-O Set an additional range selection 
end point at the playhead or 
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Command Shortcut Action
Set Additional Selection Start Command-Shift-I Set an additional range selection 
start point at the playhead or 
skimmer location
Show/Hide Precision Editor Control-E When an edit point is selected, 
show or hide the Precision Editor
Snapping N Turn snapping on or off
Solo Option-S Solo the selected items in 
the Timeline
Source Media: Audio & Video Shift-1 Turn on audio/video mode to add 
the video and audio portion of 
your selection to the Timeline
Source Media: Audio Only Shift-3 Turn on audio-only mode to add 
the audio portion of your selection 
to the Timeline
Source Media: Video Only Shift-2 Turn on video-only mode to add 
the video portion of your selection 
to the Timeline
Switch to Viewer Angle 1 Option-1 Switch the multicam clip to angle 
1 of the current bank
Switch to Viewer Angle 2 Option-2 Switch the multicam clip to angle 
2 of the current bank
Switch to Viewer Angle 3 Option-3 Switch the multicam clip to angle 
3 of the current bank
Switch to Viewer Angle 4 Option-4 Switch the multicam clip to angle 
4 of the current bank
Switch to Viewer Angle 5 Option-5 Switch the multicam clip to angle 
5 of the current bank
Switch to Viewer Angle 6 Option-6 Switch the multicam clip to angle 
6 of the current bank
Switch to Viewer Angle 7 Option-7 Switch the multicam clip to angle 
7 of the current bank
Switch to Viewer Angle 8 Option-8 Switch the multicam clip to angle 
8 of the current bank
Switch to Viewer Angle 9 Option-9 Switch the multicam clip to angle 
9 of the current bank
Toggle Storyline Mode G Turn on or turn off the ability to 
build storylines when dragging 
clips in the Timeline
Trim End Option-Right Bracket (]) Trim the end of the selected or 
topmost clip to the skimmer or 
playhead position 
Trim Start Option-Left Bracket ([) Trim the clip start point to the 
skimmer or playhead position 
Trim to Selection Option-Backslash (\) Trim clip start and end points to 
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Effects
Command Shortcut Action
Add Basic Lower Third Shift-Control-T Connect a basic lower-third title 
to the primary storyline
Add Basic Title Control-T Connect a basic title to the 
primary storyline
Add Default Transition Command-T Add the default transition to 
the selection
Color Board: Reset Current Board 
Controls
Option-Delete Reset the controls in the current 
Color Board pane
Color Board: Switch to the 
Color Pane
Command-Control-C Switch to the Color pane in the 
Color Board
Color Board: Switch to the 
Exposure Pane
Command-Control-E Switch to the Exposure pane in the 
Color Board
Color Board: Switch to the 
Saturation Pane
Command-Control-S Switch to the Saturation pane in 
the Color Board
Copy Effects Command-Option-C Copy the selected effects and 
their settings
Enable/Disable Balance Color Command-Option-B Turn Balance Color corrections on 
or off
Match Audio Command-Shift-M Match the sound between clips
Match Color Command-Option-M Match color between clips
Next Text Option-Tab Navigate to the next text item
Paste Attributes Command-Shift-V Paste selected attributes and their 
settings to the selection
Paste Effects Command-Option-V Paste effects and their settings to 
the selection
Previous Text Shift-Option-Tab Navigate to the previous text item
Retime Editor Command-R Show or hide the Retime Editor
Retime: Create Normal Speed 
Segment
Shift-N Set the selection to play at normal 
(100 percent) speed
Retime: Hold Shift-H Create a 2-second hold segment
Retime: Reset Command-Option-R Reset the selection to play forward 
at normal (100 percent) speed
Solo Animation Shift-Control-V Show one effect at a time in the 
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General
Command Shortcut Action
Delete Delete Delete the Timeline selection, reject 
the Event Browser selection, or 
remove a multicam through edit
Find Command-F Show or hide the Filter window (in 
the Event Browser) or the Timeline 
Index (in the Timeline)
Go to Event Viewer Command-Option-3 Make the Event Viewer active
Import Media Command-I Import media from a device, a 
camera, or an archive
Move to Trash Command-Delete Move the selection to the 
Finder Trash
New Project Command-N Create a new project
Project Properties Command-J Open the Properties inspector for 
the current project
Render All Shift-Control-R Start all rendering tasks for the 
current project
Render Selection Control-R Start rendering tasks for the 
selection
Reveal in Finder Command-Shift-R Reveal the selected event clip’s 
source media file in the Finder
Marking
Command Shortcut Action
Add Marker M Add a marker at the location of 
the skimmer or playhead
Add Marker and Modify Option-M Add a marker and edit the 
marker’s text
Apply Keyword Tag 1 Control-1 Apply keyword 1 to the selection
Apply Keyword Tag 2 Control-2 Apply keyword 2 to the selection
Apply Keyword Tag 3 Control-3 Apply keyword 3 to the selection
Apply Keyword Tag 4 Control-4 Apply keyword 4 to the selection
Apply Keyword Tag 5 Control-5 Apply keyword 5 to the selection
Apply Keyword Tag 6 Control-6 Apply keyword 6 to the selection
Apply Keyword Tag 7 Control-7 Apply keyword 7 to the selection
Apply Keyword Tag 8 Control-8 Apply keyword 8 to the selection
Apply Keyword Tag 9 Control-9 Apply keyword 9 to the selection
Clear Selected Ranges Option-X Clear the range selection
Clear Range End Option-O Clear the range’s end point
Clear Range Start Option-I Clear the range’s start point
Delete Marker Control-M Delete the selected marker
Delete Markers in Selection Shift-Control-M Delete all of the markers in 
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Command Shortcut Action
Deselect All Command-Shift-A Deselect all selected items
Favorite F Rate the Event Browser selection 
as Favorite 
New Keyword Collection Command-Shift-K Create a new Keyword Collection
New Smart Collection Command-Option-N Create a new Smart Collection
Range Selection Tool R Make the Range Selection 
tool active
Remove All Keywords From 
Selection
Control-0 Remove all keywords from the 
Event Browser selection
Roles: Apply Dialogue Role Option-Control-D Apply the Dialogue role to the 
selected clip
Roles: Apply Effects Role Option-Control-E Apply the Effects role to the 
selected clip
Roles: Apply Music Role Option-Control-M Apply the Music role to the 
selected clip
Roles: Apply Titles Role Option-Control-T Apply the Titles role to the 
selected clip
Roles: Apply Video Role Option-Control-V Apply the Video role to the 
selected clip
Select All Command-A Select all clips
Select Clip Range X Set the range selection to match 
the boundaries of the clip below 
the skimmer or playhead
Set Additional Range End Command-Shift-O Set an additional range selection 
end point at the playhead or 
skimmer location
Set Additional Range Start Command-Shift-I Set an additional range selection 
start point at the playhead or 
skimmer location
Set Range End O Set the end point for the range
Set Range End Control-O Set the end point for the range 
while editing a text field
Set Range Start I Set the start point for the range
Set Range Start Control-I Set the start point for the range 
while editing a text field
Unrate U Remove ratings from the selection
Organization
Command Shortcut Action
New Event Option-N Create a new event
New Folder Command-Shift-N Create a new folder
Reveal in Event Browser Shift-F Reveal the selected clip in the 
Event Browser
Synchronize Clips Command-Option-G Synchronize the selected 
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Playback/Navigation
Command Shortcut Action
Audio Skimming Shift-S Turn audio skimming on or off
Audition: Preview Command-Control-Y Play the pick in context in 
the Timeline
Clip Skimming Command-Option-S Turn clip skimming on or off
Cut/Switch Multicam Audio Only Shift-Option-3 Turn on audio-only mode for 
multicam cutting and switching
Cut/Switch Multicam Audio and 
Video
Shift-Option-1 Turn on audio/video mode for 
multicam cutting and switching
Cut/Switch Multicam Video Only Shift-Option-2 Turn on video-only mode for 
multicam cutting and switching
Down Down Arrow Go to the next item (in the Event 
Browser) or the next edit point (in 
the Timeline)
Down Control-Down Arrow While editing a text field, go to 
the next item (in the Event 
Browser) or the next edit point 
(in the Timeline)
Go Back 10 Frames Shift-Left Arrow Move the playhead back 10 frames
Go Forward 10 Frames Shift-Right Arrow Move the playhead forward 
10 frames
Go to Beginning Home button Move the playhead to the 
beginning of the Timeline or the 
first clip in the Event Browser
Go to Next Bank Shift-Option-Apostrophe (’) Display the next bank of angles in 
the current multicam clip
Go to Next Edit Apostrophe (’) Move the playhead to the next 
edit point in the Timeline
Go to Next Field Option-Right Arrow Move the playhead to the next 
field in an interlaced clip
Go to Next Frame Right Arrow Move the playhead to the 
next frame
Go to Next Subframe Command-Right Arrow Move the playhead to the next 
audio subframe
Go to Previous Bank Shift-Option-Semicolon (;) Display the previous bank of 
angles in the current multicam clip
Go to Previous Edit Semicolon (;) Move the playhead to the previous 
edit point in the Timeline
Go to Previous Field Option-Left Arrow Move the playhead to the previous 
field in an interlaced clip
Go to Previous Frame Left Arrow Move the playhead to the 
previous frame
Go to Previous Subframe Command-Left Arrow Move the playhead to the previous 
audio subframe
Go to Range End Shift-O Move the playhead to the end of 
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Command Shortcut Action
Go to Range Start Shift-I Move the playhead to the 
beginning of the range selection
Loop Playback Command-L Turn looped playback on or off
Monitor Audio Shift-A Turn on or turn off audio 
monitoring for the angle 
being skimmed
Negative Timecode Entry Hyphen (-) Enter a negative timecode value to 
move the playhead back, move a 
clip earlier, or trim a range or clip, 
depending on your selection
Next Clip Command-Control-Right Arrow Go to the next item (in the Event 
Browser) or the next edit point (in 
the Timeline)
Next Marker Control-Apostrophe (’) Move the playhead to the 
next marker
Play Around Shift-Question Mark (?) Play around the playhead position
Play Forward L Play forward (press L multiple times 
to increase the playback speed)
Play Forward Control-L Play forward while editing a text 
field (press L multiple times to 
increase the playback speed)
Play from Playhead Option-Space bar Play from the playhead position
Play Full Screen Command-Shift-F Play full screen from the skimmer 
or playhead position
Play Reverse J Play in reverse (press J multiple 
times to increase the reverse 
playback speed)
Play Reverse Control-J Play in reverse while editing 
a text field (press J multiple 
times to increase the reverse 
playback speed)
Play Reverse Shift-Space bar Play in reverse
Play Selection Slash (/) Play the selection
Play to End Shift-Control-O Play from the playhead to the end 
of the selection
Play/Pause Space bar Start or pause playback
Play/Pause Control-Space bar Start or pause playback while 
editing a text field
Positive Timecode Entry Equal Sign (=) Enter a positive timecode value to 
move the playhead forward, move 
a clip later, or trim a range or clip, 
depending on your selection
Previous Clip Command-Control-Left Arrow Go to the previous item (in the 
Event Browser) or the previous 
edit point (in the Timeline)
Previous Marker Control-Semicolon (;) Move the playhead to the 
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Command Shortcut Action
Set Monitoring Angle Shift-V Set the angle being skimmed as 
the monitoring angle
Skimming S Turn skimming on or off
Stop K Stop playback
Stop Control-K Stop playback while editing a 
text field
Timeline History Back Command-Left Bracket ([) Go back one level in the 
Timeline history
Timeline History Forward Command-Right Bracket (]) Go forward one level in the 
Timeline history
Up Up Arrow Go to the previous item (in the 
Event Browser) or the previous edit 
point (in the Timeline)
Up Control-Up Arrow While editing a text field, go to 
the previous item (in the Event 
Browser) or the previous edit point 
(in the Timeline)
Share and Tools
Command Shortcut Action
Share to Default Destination Command-E Share the selected project or clip 
using the default destination
Select (Arrow) Tool A Make the Select tool active
Blade Tool B Make the Blade tool active
Crop Tool Shift-C Make the Crop tool active and 
display onscreen controls for the 
selected clip or the topmost clip 
under the playhead
Distort Tool Command-Shift-D Make the Distort tool active and 
display onscreen controls for the 
selected clip or the topmost clip 
under the playhead
Hand Tool H Make the Hand tool active
Position Tool P Make the Position tool active
Transform Tool Shift-T Make the Transform tool active 
and display onscreen controls for 
the selected clip or the topmost 
clip under the playhead
Trim Tool T Make the Trim tool active
Zoom Tool Z Make the Zoom tool activeChapter 17 Keyboard shortcuts and gestures 450
View
Command Shortcut Action
Clip Appearance: Clip Labels Only Option-Control-6 Depending on the clip name 
setting, display Timeline clips with 
clip names, role names, or active 
angle names only
Clip Appearance: Decrease 
Waveform Size
Option-Control-Down Arrow Decrease the size of audio 
waveforms for Timeline clips
Clip Appearance: Filmstrips Only Option-Control-5 Display Timeline clips with large 
filmstrips only
Clip Appearance: Increase 
Waveform Size
Option-Control-Up Arrow Increase the size of audio 
waveforms for Timeline clips
Clip Appearance: Large Filmstrips Option-Control-4 Display Timeline clips with 
small audio waveforms and l
arge filmstrips
Clip Appearance: Large Waveforms Option-Control-2 Display Timeline clips with 
large audio waveforms and 
small filmstrips
Clip Appearance: Waveforms and 
Filmstrips
Option-Control-3 Display Timeline clips with audio 
waveforms and video filmstrips of 
equal size
Clip Appearance: Waveforms Only Option-Control-1 Display Timeline clips with large 
audio waveforms only
Decrease Clip Height Command-Shift-Hyphen (-) Decrease the Event Browser 
clip height
Increase Clip Height Command-Shift-Equal Sign (=) Increase the Event Browser 
clip height
Show Fewer Filmstrip Frames Command-Shift-Comma (,) Show fewer filmstrip frames in 
Event Browser clips
Show/Hide Audio Animation Control-A Show or hide the Audio Animation 
Editor for the selected clips
Show/Hide Skimmer Info Control-Y Show or hide clip information 
when skimming in the 
Event Browser
Show/Hide Video Animation Control-V Show or hide the Video 
Animation Editor for the selected 
Timeline clips
Show More Filmstrip Frames Command-Shift-Period (.) Show more filmstrip frames in 
Event Browser clips
Show One Frame per Filmstrip Command-Shift-Option-Comma (,) Show one frame per filmstrip
View Clip Names Shift-Option-N Show or hide clip names in the 
Event Browser
View Event Browser as Filmstrip Command-Option-1 Switch the Event Browser to 
filmstrip view
View Event Browser as List Command-Option-2 Switch the Event Browser to 
list view
Zoom In Command-Equal Sign (=) Zoom in to the Timeline, Event 
Browser, or ViewerChapter 17 Keyboard shortcuts and gestures 451
Command Shortcut Action
Zoom Out Command-Hyphen (-) Zoom out of the Timeline, Event 
Browser, or Viewer
Zoom to Fit Shift-Z Zoom the contents to fit the size 
of the Event Browser, Viewer, 
or Timeline
Zoom to Samples Control-Z Turn zooming in to audio samples 
on or off
Windows
Command Shortcut Action
Background Tasks Command-9 Show or hide the Background 
Tasks window
Go to Audio Enhancements Command-8 Make the Audio Enhancements 
inspector active
Go to Color Board Command-6 Make the Color Board active
Go to Event Browser Command-1 Make the Event Browser active
Go to Inspector Command-Option-4 Make the current inspector active
Go to Timeline Command-2 Make the Timeline active
Go to Viewer Command-3 Make the Viewer active
Next Tab Control-Tab Go to the next pane in the 
Inspector or the Color Board
Previous Tab Shift-Control-Tab Go to the previous pane in the 
Inspector or the Color Board
Show Histogram Command-Control-H Show the Histogram in the Viewer
Show Vectorscope Command-Control-V Show the Vectorscope in 
the Viewer
Show Video Waveform Command-Control-W Show the Waveform Monitor in 
the Viewer
Show/Hide Angles Command-Shift-7 Show or hide the Angle Viewer
Show/Hide Audio Meters Command-Shift-8 Show or hide the Audio meters
Show/Hide Effects Browser Command-5 Show or hide the Effects Browser
Show/Hide Event Library Command-Shift-1 Show or hide the Event Library
Show/Hide Event Viewer Command-Control-3 Show or hide the Event Viewer 
Show/Hide Inspector Command-4 Show or hide the Inspector pane
Show/Hide Keyword Editor Command-K Show or hide the Keyword Editor
Show/Hide Project Library Command-0 Show or hide the Project Library
Show/Hide Timeline Index Command-Shift-2 Show or hide the Timeline Index 
for the open project
Show/Hide Video Scopes Command-7 Show or hide the video scopes in 
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Multi-Touch gestures
If your computer has a Multi-Touch trackpad, you can use the Multi-Touch gestures listed in the 
table below when working with Final Cut Pro.
For more information about Multi-Touch gestures, see the documentation that came with 
your computer.
Gesture Action
Scroll (two-finger): Moves the Timeline left, right, up, or down. 
Scroll (three-finger): Swipe up to move the playhead to the beginning 
of the Timeline. Swipe down to move the playhead to the end of the 
Timeline. Swipe left or right to move the playhead left or right.
Customize keyboard shortcuts
View keyboard shortcuts in the Command Editor
Final Cut Pro provides a wide variety of menu commands and keyboard shortcuts that let you 
control almost every aspect of your project, from playback to displaying windows and inspectors 
to working with tools. You can use the Command Editor to modify existing shortcuts, create new 
shortcuts, and save multiple sets of keyboard shortcuts that you can export for others to use. You 
can also import a set of shortcuts that someone else created. And if you’re more familiar with 
keyboard shortcuts from other applications, you can use the Command Editor to substitute those 
shortcuts in place of the default set for Final Cut Pro.
The Command Editor provides a set of keyboard shortcuts for Final Cut Pro in English, Japanese, 
French, and German. The language that is shown is determined by your computer’s operating 
system. To learn how to change the language used by Final Cut Pro, see OS X Help, available from 
the Help menu when the Finder is active.
View keyboard shortcuts
1 Choose Final Cut Pro > Commands > Customize (or press Command-Option-K). 
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2 To find keyboard shortcuts in the Command Editor, do any of the following:
• Click one or more keys on the virtual keyboard (or click one of the four modifier buttons at the 
top of the Command Editor).
The Command groups associated with the selected key or keys appear in the bottom-left 
corner of the window, and a list of all the keyboard shortcuts associated with the key you 
selected appears in the bottom-right corner of the window. 
Select a key to see the Command 
groups associated with the key.
When you hold down any modifier buttons on the keyboard, the key colors update. Key colors 
correspond with command classifications; for example, playback commands, such as Play/
Pause (Space bar), are blue. The Command Groups window on the left side of the Command 
List contains a clickable color key for reference.
• Enter a command name, description keywords, or a key name in the search field at the topright corner of the window.
The commands that match the search term are listed in the Command List at the bottom of 
the window.
Tip: To show the keys that correspond with the items in the Command List, click the Keyboard 
Highlight button to the left of the search field.Chapter 17 Keyboard shortcuts and gestures 454
Click any command in the list to view its details in the Command Detail area in the bottomright corner of the window. 
Commands located 
by the search
Enter a term to 
search for here.
• Click a Command group to quickly filter the Command List to display only the commands and 
keyboard shortcuts in that group.
Click any command in the list to view its details in the Command Detail area in the bottomright corner of the window. 
Click a Command group to 
quickly filter the Command List.Chapter 17 Keyboard shortcuts and gestures 455
View shortcuts from a different command set
If your system has multiple command sets, you can easily switch between them. For more 
information, see Export and import command sets in the Command Editor on page 456.
Do one of the following:
m Choose Final Cut Pro > Commands, and then choose a command set from the submenu.
The Command Editor window appears, showing the command set you chose.
m If you’ve already opened the Command Editor, choose a command set from the pop-up menu at 
the top-left corner of the window.
Command sets are 
listed in the bottom 
of the pop-up menu.
Modify keyboard shortcuts in the Command Editor
You can quickly and easily customize keyboard shortcuts in the Command Editor. If you want to 
add a few custom commands to the default set in Final Cut Pro, you can duplicate the default set 
and assign keyboard shortcuts to some of the unassigned commands. You can also create a new 
set that contains only your commands.
Duplicate a command set
1 Choose Final Cut Pro > Commands > Customize (or press Command-Option-K).
2 If the command set that you want to duplicate is not shown, choose a different command set 
from the pop-up menu in the top-left corner of the Command Editor.
3 Choose Duplicate from the pop-up menu.
4 In the window that appears, type a name for the command set, and click OK.
The duplicate set is added to the Command submenu of the Final Cut Pro menu and to the 
pop-up menu in the Command Editor.
Modify a command set
You can add keyboard shortcuts to a command set or reassign keyboard shortcuts.
1 Choose Final Cut Pro > Commands > Customize (or press Command-Option-K).
2 If the command set that you want to modify is not shown, select a different different command 
set from the pop-up menu at the top of the Command Editor.
3 Select the command to which you want to assign a new keyboard shortcut by doing one of 
the following:
• Type a command name in the search field at the top-right corner of the Command 
Editor window.
• Browse the command list to find the command you want.Chapter 17 Keyboard shortcuts and gestures 456
4 Press the combination of keys you want to use for the command (for example, Shift-Option-T, or 
any other keys).
Note: Keys on the Command Editor virtual keyboard that are shaded with diagonal lines are 
reserved for system use and cannot be assigned.
If the key combination is not already assigned to a command, the virtual keyboard updates to 
show the new key assignment. A gray dot appears on a newly assigned key (or keys), and a color 
is applied if the command belongs to a color-coded Command group.
If the key combination is already assigned to a command, Final Cut Pro displays the current 
setting, and prompts you to confirm the change.
5 To save your changes to the command set, click the Save button in the lower-right corner of the 
Command Editor.
If you close the Command Editor with unsaved changes, Final Cut Pro prompts you to save 
your changes.
Delete a command set
1 Choose Final Cut Pro > Commands > Customize (or press Command-Option-K).
2 If the command set that you want to delete is not shown, select a different command set from 
the pop-up menu at the top of the Command Editor.
3 Choose Delete from the pop-up menu in the top-left corner of the Command Editor.
4 In the window that appears, click Delete.
The command set is removed.
Export and import command sets in the Command Editor
After you save a command set, you may want to export it to create a backup or to share the new 
set with another user. Exported command sets are saved in a file that can be imported back into 
Final Cut Pro at a later time.
Export a set of custom keyboard shortcuts
1 Choose Final Cut Pro > Commands > Customize (or press Command-Option-K).
2 If the command set that you want to export is not shown, select a different command set from 
the pop-up menu at the top of the Command Editor.
3 Do one of the following:
• Choose Final Cut Pro > Commands > Export.
• Choose Export from the pop-up menu in the top-left corner of the Command Editor.
4 Type a name for the exported command set in the Save As field, and navigate to the location 
where you want to save the exported set and click Save.
The file is saved in the location you chose, with the filename extension .commandset.Chapter 17 Keyboard shortcuts and gestures 457
Import a command set
1 Do one of the following:
• Choose Final Cut Pro > Commands > Import.
• Open the Command Editor by choosing Final Cut Pro > Commands > Customize, and choose 
Import from the pop-up menu in the upper-left corner of the Command Editor.
2 In the window that appears, navigate to the location where you’ve stored a command set file, 
select it, and click Open.
If you’re already using a command set with the same name, a window appears and prompts you 
to rename the command set.
The new command set is added to the Commands submenu of the Final Cut Pro menu and to 
the pop-up menu in the Command Editor.458
4:3 The aspect ratio for standard-definition (SD) broadcast video. The ratio of the width to the 
height of the visible area of the video frame is 4:3, or 1.33. See also standard-definition (SD).
16:9 A widescreen aspect ratio for video. The ratio of the width to the height of the visible area 
of the video frame is 16:9, or 1.78. The 16:9 aspect ratio is used for high-definition video. See also 
high-definition (HD).
AAC (Advanced Audio Coding) Also called MPEG-4 Audio. A standard way of compressing and 
encoding digital audio. AAC-encoded files rival the quality of audio CDs and generally sound as 
good as or better than MP3 files encoded at the same or even a higher bit rate.
AC3 (Audio Codec 3, Advanced Codec 3, Acoustic Coder 3) A Dolby Digital compressed audio 
format often used for encoding surround sound.
AIFF (Audio Interchange File Format) A cross-platform audio file format developed by Apple. 
Like WAV files, AIFF files contain “chunks” of information such as the Sound Data Chunk, which 
contains the actual sample data, and the Common Chunk, which contains sample rate and bit 
depth information.
alpha channel An image channel in addition to the R, G, and B color channels that is used 
to store transparency information for compositing. Alpha channels are often 8-bit, but some 
applications support 16-bit alpha channels. In Final Cut Pro, black represents 100 percent 
transparency, and white represents 100 percent opacity. Only certain formats, such as Targa, TIFF, 
PNG, PSD, Apple ProRes 4444, and the QuickTime Animation codec, support alpha channels. See 
also compositing, RGB.
Angle Editor You can open multicam clips in the Angle Editor to adjust the synchronization and 
the angle order, or to add or delete angles. You can also use the Angle Editor to make edits to 
the individual clips inside a multicam clip (such as trimming, making color corrections, adding 
transitions, and so on). See also multicam clip.
Angle Viewer A viewer used to watch all angles of a multicam clip simultaneously while 
switching or cutting to different angles in real time. You can cut and switch video and audio 
at the same time or independently. For example, you can use the audio from angle 1 while 
switching the video between angles 1 to 4. See also multicam clip.
Animation Editors See Audio Animation Editor, Video Animation Editor.
Apple ProRes The Apple ProRes codecs provide an unparalleled combination of multistream, 
real-time editing performance coupled with impressive image quality at reduced storage rates. In 
particular, the Apple ProRes codecs have been designed to work especially well as high-quality, 
high-performance editing codecs for Final Cut Pro, taking full advantage of multicore processing 
and featuring fast, reduced-resolution decoding modes. All members of the Apple ProRes codec 
family support any frame size (including SD, HD, 2K, and 4K) at full resolution. The data rate of 
Apple ProRes varies based on codec type, image content, frame size, and frame rate.
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Apple ProRes 4444 This Apple ProRes codec offers the best quality for 4:4:4:4 sources and for 
workflows involving alpha channels. It features full-resolution, mastering-quality 4:4:4:4 RGBA 
color, perceptually indistinguishable from the original material with excellent multigeneration 
performance. It also features a mathematically lossless alpha channel (up to 16 bits) with 
real-time playback, a high-quality solution for storing and exchanging motion graphics and 
composites, and direct encoding of, and decoding to, both RGB and Y'CbCr pixel formats. This 
codec has a remarkably low data rate compared to uncompressed 4:4:4 HD (the target data rate 
is approximately 330 Mbps for 4:4:4 sources at 1920 x 1080 and 29.97 fps). See also Apple ProRes.
Apple ProRes 422 (HQ) This Apple ProRes codec preserves visual quality at the same high 
level as Apple ProRes 4444, but for 4:2:2 image sources. With widespread adoption across the 
video post-production industry, Apple ProRes 422 (HQ) offers visually lossless preservation of 
the highest-quality professional HD video that a (single-link) HD-SDI signal can carry. This codec 
supports full-width, 4:2:2 video sources at 10-bit pixel depths, while remaining visually lossless 
through many generations of decoding and reencoding. The target data rate of Apple ProRes 
422 (HQ) is approximately 220 Mbps at 1920 x 1080 and 29.97 fps. See also Apple ProRes.
Apple ProRes 422 This Apple ProRes codec offers nearly all the benefits of Apple ProRes 
422 (HQ), but at 66 percent of the data rate for even better multistream, real-time editing 
performance. See also Apple ProRes.
Apple ProRes 422 (LT) With a target data rate that is roughly 70 percent of the data rate of 
Apple ProRes 422 and 30 percent smaller file sizes than Apple ProRes 422, this Apple ProRes 
codec is perfect for environments where storage capacity and bandwidth are at a premium. See 
also Apple ProRes.
Apple ProRes 422 (Proxy) This Apple ProRes codec is intended for use in offline workflows that 
require low data rates but full-resolution video. The target data rate is roughly 30 percent of the 
data rate of Apple ProRes 422. See also Apple ProRes.
aspect ratio A film or video frame’s width-to-height ratio on any viewing screen. Standarddefinition (SD) video (used for regular television screens) has an aspect ratio of 4:3. Highdefinition (HD) video has an aspect ratio of 16:9.
Audio Animation Editor You can show the Audio Animation Editor for clips in the Timeline 
to adjust effect parameters, create fade-ins or fade-outs, or change effects over time 
using keyframes.
audio components Audio files can contain a single audio channel or multiple audio channels. 
Final Cut Pro automatically groups audio channels into audio components according to how the 
channels are configured for the clip. In Final Cut Pro, you can expand the audio portion of clips to 
view and edit audio components down to the individual channel level.
audio sample rate The number of times an audio signal is measured, or sampled, per second. A 
higher sample rate produces higher-quality audio and larger file sizes, and a lower sample rate 
produces lower-quality audio and smaller file sizes.
Audio Units The standard real-time audio filter format for audio applications used withOS X.
audio waveforms Audio waveforms are visual representations of the actual sound. An audio 
waveform’s amplitude and length change according to the underlying sound’s volume and 
duration. A short, loud sound such as a drum beat has a sharp, peaked waveform, whereas lowlevel crowd noise has a lower, more uniform waveform. These properties make it easier to find 
specific edit points when trimming clips or keyframing effects.Glossary 460
audition In Final Cut Pro you can organize related clips into sets, called auditions, from which 
you can choose one clip to use. You can create an audition composed of different clips to try out 
multiple takes, or you can create an audition composed of multiple versions of the same clip to 
preview different effects. Auditions appear in the Event Browser and Timeline as clips with an 
Audition icon in the upper-left corner.
automatic audio sync The “Use audio for synchronization” option in the multicam clip creation 
process makes precision sync adjustments using audio waveforms in the angles of a multicam 
clip. This is the same audio sync technology that you can use to automatically analyze and sync 
clips together into a compound clip.
AVCHD A high-definition (HD) video format that uses Advanced Video Coding (AVC) 
compression (also known as MPEG-4 part 10 or H.264). Many Blu-ray players can play red laser 
discs with AVCHD format content, making this a common way to distribute short HD video 
projects using a standard red laser disc.
Background Tasks window The Background Tasks window shows the progress of importing, 
transcoding, analysis, rendering, sharing, and other tasks.
batch Compressor uses a batch to contain one or more source media files that you want to 
convert, or transcode, to another format. Each source media file creates its own job. This means 
that a batch can contain multiple jobs, with each job based on its own source media file. Each 
job also has at least one setting that defines the format of the transcoded file.
bit rate The number of bits per second that makes up a digital video or audio asset. The higher 
the bit rate, the better the quality. However, higher bit rates require larger file sizes.
Blade tool The editing tool that allows you to cut clips in the Timeline. You can select the Blade 
tool by pressing the B key.
blue laser media Blu-ray burners and players use a blue laser when working with Blu-ray media. 
The blue color has a shorter wavelength, making it possible to store more data on a disc when 
compared to red lasers.
blue or green screening See chroma key.
broadcast-safe Broadcast facilities have limits on the maximum values of luma and chroma that 
are allowable for broadcast. If a video exceeds these limits, distortion can appear, resulting in 
unacceptable transmission quality. You can use the Final Cut Pro video scopes to make sure that 
the luma and chroma levels you set stay within acceptable limits.
B-roll A term used to describe alternate footage shot to intercut with the primary shots used in 
a program. B-roll is frequently used for cutaway shots.
BWF (Broadcast Wave Format) An extension of the WAV file format that includes additional 
metadata such as timecode and production information.
CAF (Core Audio Format) Apple’s Core Audio Format (CAF) is a flexible file format for storing 
and manipulating digital audio data. It is fully supported by Core Audio APIs on Mac OS X v10.4 
and later and on Mac OS X v10.3 with QuickTime 7 or later. CAF provides high performance and 
flexibility, and is scalable to future ultra high-resolution audio recording, editing, and playback.
chroma The color information contained in a video signal, consisting of hue, which represents 
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chroma key A special effects technique that allows you to derive an alpha channel or matte 
from the blue or green background of a video clip in order to make it transparent for the 
purpose of compositing it against other clips. Blue-screen technology is what makes weather 
forecasters appear to be standing against an animated map, when in reality they’re standing in 
front of a blue wall. Also known as blue or green screening. See also alpha channel.
clip The term used to describe a video or audio asset, especially after it has been imported into 
Final Cut Pro. Clips appear in the Event Browser, the Timeline, and the media browsers. Clips in 
Final Cut Pro point to (link to) source media files stored on a disk. When you modify a clip, you 
are not modifying the media file, just the clip’s information in Final Cut Pro. (This is known as 
nondestructive editing.)
clipping Distortion occurring during the playback or recording of digital audio because of a 
signal that exceeds the maximum sample value of 0 dBFS.
clip selection A selection of whole clips in the Event Browser or the Timeline. In contrast to a 
range selection, a clip selection is limited to clip boundaries. You cannot adjust a clip selection to 
include portions of clips. However, you can add or remove whole clips.
codec Short for compressor/decompressor, or encode/decode. A software component used to 
translate video or audio from its current form to the digital compressed form in which it is 
stored on a computer’s hard disk. DV, Photo JPEG, and Apple ProRes are common QuickTime 
video codecs.
color balance Refers to the mix of red, green, and blue in a clip. In Final Cut Pro, you can adjust 
the color balance of the highlights (bright areas), midtones, or shadows (dark areas) of your clip 
using the Color Board.
color bars A standard color test signal displayed as columns, often accompanied by a reference 
audio tone. Color bars are used to adjust the video signal of the incoming source to maintain 
proper color from import through output.
Color Board The Color Board allows you to manually adjust a clip’s color properties. It contains 
separate panes for adding or subtracting a color tint, controlling the intensity of the color, and 
controlling the brightness of the video. In addition to an overall control, each pane has individual 
controls for the highlight, midtone, and shadow areas of the image.
color cast An unwanted color tint in the image, usually caused by lighting issues.
color correction A process in which the color of clips used in an edited program is evened out 
so that all shots in a given scene match. Color correction is generally one of the last steps in 
finishing an edited program. The color correction tools in Final Cut Pro give you precise control 
over the look of every clip in your project by allowing you to adjust the color balance, black 
levels, midtones, and white levels of individual clips.
color difference In video formats that store color information in the Y'CbCr color space, color 
channels are derived by subtracting Y (luma) from the R (red) and B (blue) signals and are 
sometimes referred to generally as B-Y and R-Y. See also Y'CbCr.
compositing A process in which two or more images are combined into a single frame. This 
term can also describe the process of creating various video effects.Glossary 462
compound clip You can use compound clips to group any combination of clips in the Timeline 
or the Event Browser, and nest clips within other clips. You can open any compound clip, edit 
its contents in the Timeline, and then close it. Compound clips can contain video and audio clip 
components, clips, and other compound clips. Effectively, each compound clip can be considered 
a mini project, with its own distinct project settings. Compound clips function just like other 
clips: you can add them to your project, trim them, retime them, and add effects and transitions.
compression The process by which video, graphics, and audio files are reduced in size. “Lossy” 
compression refers to a process of reducing video file sizes through the removal of redundant 
or less noticeable image data. Lossless compression reduces file sizes by mathematically 
consolidating redundant image data without discarding it.
connected clip Connected clips are attached to clips in the primary storyline in the Timeline. 
They are useful for cutaway shots, superimposed or composited images, and sound effects. 
Connected clips remain attached and synchronized until you explicitly move or remove them. A 
sequence of connected clips is a storyline.
contrast The difference between the lightest and darkest values in an image. High-contrast 
images have a large range of values from the darkest shadow to the lightest highlight. Lowcontrast images have a more narrow range of values, resulting in a “flatter” look.
cross dissolve A common type of video transition, in which the first shot fades out while the 
second shot simultaneously fades in. During the cross dissolve, the two shots are superimposed 
as they fade.
crossfade A common type of audio transition, in which the first shot’s audio fades down while 
the second shot’s audio simultaneously fades up. During the crossfade, audio from both shots 
is heard.
cut An edit in which one clip immediately follows another, with no transition effect. This is the 
simplest type of edit.
cutaway shot A shot that is related to the current subject and occurs in the same time frame 
(for example, an interviewer’s reaction to what is being said in an interview). Often, a cutaway 
shot is used to eliminate an unwanted visual section of another shot. The audio usually remains 
continuous during the cutaway, helping to make the edit less noticeable.
Dashboard The Dashboard appears in the center of the toolbar and provides a timecode display 
as well as icons showing audio levels and the status of background tasks.
data rate The speed at which data can be transferred, often described in megabytes per second 
(MB/sec.) or megabits per second (Mbps). The higher a video file’s data rate, the higher quality it 
is, but the more system resources (processor speed, hard disk space, and performance) it requires. 
Some codecs allow you to specify a maximum data rate for a movie during capture.
decibel (dB) Unit of measurement for sound levels; a logarithmic scale used to describe the 
loudness of sound as perceived by the human ear. (1 dB corresponds to approximately the 
smallest volume change that the average human ear can perceive.) For digital audio, dBFS is the 
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destination A set of preconfigured export settings that you can use to share a project or clip 
from Final Cut Pro. Destinations make it easy to export your movie for viewing on Apple devices 
such as iPad and iPhone, publish your movie to websites such as YouTube or Facebook, or burn 
your movie to a disc. Final Cut Pro comes with a variety of destinations, and you can also modify 
destinations and create new destinations. You add and modify destinations in the Destinations 
pane of Final Cut Pro preferences.
Disk Utility Disk Utility is an Apple application that performs disk-related tasks inOS X. It’s 
located in the Utilities folder inside the Applications folder.
downmixing The process used to combine multiple audio channels into a single stereo (or dual 
mono) pair. Also referred to as mixing down.
drop frame timecode NTSC timecode that skips ahead in time by two frame numbers each 
minute, except every tenth minute, so that the timecode agrees with the actual elapsed clock 
time. (Timecode numbers are skipped, but actual video frames are not skipped.) This skipping 
corrects for NTSC’s actual frame rate of 29.97 fps, which causes non-drop frame timecode to lag 
behind actual elapsed time by 3 seconds and 18 frames per hour. To avoid confusion, drop frame 
timecode should be avoided in film-based productions. See also non-drop frame timecode.
drop shadow An effect that creates an artificial shadow behind an image. Typically used with 
graphics and text.
DV A standard-definition (SD) digital videotape recorder format that records an 8-bit, 5:1 
compressed component video signal with 4:1:1 color sampling (PAL uses 4:2:0). Supports two 
tracks of audio with 16-bit, 48 kHz audio sampling, or four tracks of audio with 12-bit, 32 kHz 
audio sampling.
DVCAM A standard-definition (SD) digital videotape recorder format that records an 8-bit, 5:1 
compressed component video signal with 4:1:1 color sampling (PAL uses 4:2:0). Supports two 
tracks of audio with 16-bit, 48 kHz audio sampling, or four tracks of audio with 12-bit, 32 kHz 
audio sampling.
DVCPRO A standard-definition (SD) digital videotape recorder format that records an 8-bit, 5:1 
compressed component video signal using 4:1:1 color sampling (PAL uses 4:2:0). Supports two 
tracks of audio with 16-bit, 48 kHz audio sampling.
DVCPRO 50 A standard-definition (SD) digital videotape recorder format that records an 8-bit, 
3.3:1 compressed component video signal with 4:2:2 color sampling. Supports four tracks of 
audio with 16-bit, 48 kHz audio sampling.
DVCPRO HD A high-definition (HD) video format that records an 8-bit, compressed component 
video signal with 4:2:2 color sampling. Both 720p and 1080i are supported. Includes up to eight 
tracks of audio with 16-bit, 48 kHz audio sampling. The total data rate is 115 Mbps.
DVD A disc that is the size of a CD but that uses higher-density storage methods to significantly 
increase its capacity. Although usually used for video distribution, DVD-ROM discs can also be 
used to store computer data.
dynamic range The difference, in decibels, between the loudest and softest parts of a recording.
editing tools The seven tools from which you can choose when you’re working in the Timeline: 
Select tool, Trim tool, Position tool, Range Selection tool, Blade tool, Zoom tool, and Hand tool. 
When you choose a tool, the pointer changes to the icon for that tool.Glossary 464
edit point Edit points define the part of a clip you want to use in an edited project. Edit points 
include start points, which specify the beginning of a section of a clip or project, and end points, 
which specify the end of a section of a clip or project. An edit point is also a point in the Timeline 
where the end point of one clip meets the start point of the next clip. This edit point can be 
selected for various operations.
Effects Browser A media browser in Final Cut Pro that contains video and audio clip effects.
equalization An equalizer (commonly abbreviated as EQ) shapes the sound of incoming audio 
by changing the level of specific frequency bands. Equalization is one of the most commonly 
used audio processes, both for music projects and in video post-production work. You can use 
EQ to subtly or significantly shape the sound of an audio file, instrument, or project by adjusting 
specific frequencies or frequency ranges.
event When you import video, audio, and still images, or record directly into Final Cut Pro, the 
source media files (your raw footage) are stored in events. An event is similar to a folder that 
can hold dozens, hundreds, or even thousands of video clips, audio clips, and still images. Each 
event in the Event Library refers to a folder on your hard disk that contains the original source 
media files, any render files related to your media, and a database file that keeps track of where 
everything is.
Event Browser The Event Browser displays the clips for the item selected in the Event Library. 
You select clips or portions of clips in the Event Browser to work with them. You can sort clips in 
the Event Browser by creation date, as well as by date imported, reel, scene, clip duration, and file 
type. You can also view your clips as filmstrips or in a list.
Event Library The Event Library holds and organizes the events that contain your imported 
media (video, audio, and still images). When you select an event in the Event Library, the 
media it contains appears as clips in the Event Browser. The Event Library is also the home for 
Final Cut Pro Keyword Collections and Smart Collections, which provide a powerful way to 
organize your media using keywords and persistent search filters.
Event Viewer The Event Viewer is a separate video display that appears next to the main Viewer 
and is used to play clips in the Event Browser only.
exposure The amount of light in video or film images. Exposure affects the overall brightness of 
the image as well as its perceived contrast.
fade A common type of transition in both video and audio. For video, a fade-out begins with 
a shot at full intensity and reduces until it is gone. A fade-in begins with a shot at no intensity 
and increases to full intensity. These are the common “fade to black” and “fade up (from black)” 
transitions. Audio fade-ins begin with silence and increase to full volume, and fade-outs begin at 
full volume and decrease to silence.
filmstrip Your video clips appear as filmstrips in the Timeline (where you build projects) and 
in the Event Browser (where your source media is displayed). A single video filmstrip might 
represent several seconds of video encompassing hundreds of video frames (individual images). 
Audio-only clips appear as audio waveforms, showing the change in the audio volume over time.
FireWire The trademarked Apple name for the IEEE 1394 standard. A fast and versatile interface 
used to connect DV camcorders to computers. FireWire is well suited to applications that move 
large amounts of data, and it can also be used to connect hard disks, scanners, and other kinds of 
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Foley effects Foley effects are custom sound effects that are heavily synchronized to picture, 
such as footsteps on different surfaces, clothes rustling, fight sounds, and the handling of various 
noisy objects. Final Cut Pro includes a number of built-in Foley and other sound effects that you 
can insert as connected audio clips.
frame A single still image. Film and video are made up of a series of these images. Although a 
film frame is a single photographic image, an interlaced video frame contains two fields. See also 
interlaced video, non-interlaced video.
frame blending Duplicating frames to create slow motion can result in a strobing, jittery effect. 
To minimize this, you can turn on Frame Blending in the Retime pop-up menu in the toolbar. 
Frame blending creates new in-between frames, each a composite of two neighboring frames.
frame rate The number of images photographed per second for a video clip.
frame size See resolution.
frequency The number of times a sound or signal vibrates each second, measured in cycles per 
second, or hertz (Hz). Audio recordings are made up of a vast collection of waveforms, using 
many different frequencies of sound. Each frequency in a recording is associated with an audio 
pitch. For example, the note generated by each key of a piano has a specific frequency.
Front Row Front Row, an application that comes withOS X, is a way to navigate through your 
iTunes, iLife, and Final Cut Pro media using an Apple remote control or the Remote app. You can 
also open Front Row by pressing Command-Escape.
gain The amount an audio or video signal is boosted. In video, this increases the white level; in 
audio, this increases the volume. 
gamma A curve that describes the intensity of an image. Gamma is a nonlinear function often 
confused with brightness or contrast. Gamma adjustment is often used to compensate for 
differences between Mac and Windows video graphics cards and displays.
gap clip A blank clip (containing blank video and silent audio) that you can adjust to any 
duration. (The film industry term for this is slug.) Gap clip color is determined by the current 
background color in Final Cut Pro. You can adjust the background color using the Player 
Background pop-up menu in the Playback pane of the Final Cut Pro Preferences window.
generators Clips that are synthesized by Final Cut Pro. Generators can be used as different kinds 
of backgrounds, titles, and elements for visual design.
Generators Browser A media browser in Final Cut Pro that provides access to all video 
generators included with Final Cut Pro.
Hand tool The editing tool that allows you to scroll in the Timeline. You can select the Hand tool 
by pressing the H key.
H.264 H.264/MPEG-4 Part 10 or AVC (Advanced Video Coding) is a video compression standard 
in widespread use for recording, distribution, and Internet streaming of high-definition video.
HDCAM A high-definition (HD) digital videotape recorder format that records an 8-bit, 7.1:1 DCTcompressed component video signal with 3:1:1 color sampling. Recorded using 1/2-inch tape. 
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HDV A format for recording high-definition video on DV tape. HDV uses MPEG-2 video 
compression with 8-bit samples and 4:2:0 chroma subsampling. HDV has a video bit rate of 18.3 
Mbps for 720p (1280 x 720) and a bit rate of 25 Mbps for 1080i (1440 x 1080).
high-definition (HD) Refers to any video with a higher resolution than standard-definition NTSC 
or PAL video. The most common high-definition resolutions are 1280 x 720 (720p) and 1920 x 
1080 (1080i or 1080p). See also NTSC format, PAL format, standard-definition (SD).
Histogram A video scope in Final Cut Pro that provides a statistical analysis of the image by 
graphing the number of pixels at each percentage of luma or color. It’s useful for comparing two 
clips in order to match their brightness values more closely.
hue An attribute of color perception, also known as color phase. Red, blue, yellow, and green are 
all hues.
import The process of bringing media files of various types into events in Final Cut Pro. You can 
import files from connected camcorders and other devices, other applications, or connected 
storage devices.
IMX A standard-definition (SD), all-I-frame MPEG-2 format stored on tape, XDCAM optical disc, or 
disk drive. Some IMX decks can play back and convert formats such as Digital Betacam, Betacam 
SX, and Betacam SP to IMX. The data rate of IMX can be set to 30, 40, or 50 Mbps.
incoming clip The clip to which a transition segues. For example, if Clip A dissolves to Clip B, Clip 
B is the incoming clip. See also outgoing clip.
Info inspector The Info inspector displays information (called metadata) about a clip or group of 
clips selected in either the Event Browser or the Timeline. You can display different combinations 
of metadata with your clips, such as codecs, media start and end times, reel, scene, take, EXIF 
information, and IPTC information. You can also use the Info inspector to change the metadata 
for a selected clip or group of clips, and you can create custom sets of metadata for display using 
the Metadata Views window, accessed from the Info inspector.
In point See edit point.
insert edit An insert edit places the source clip so that all clips after the insertion point are 
moved forward (or rippled) in the Timeline to make room for the clip being added. No clips 
are removed from your project. An insert edit makes the project longer by the duration of the 
inserted clip.
inspectors Final Cut Pro provides a number of inspectors you can use to view and change the 
attributes of selected items. For example, you can adjust video effects and apply color corrections 
in the Video inspector. Other inspectors include the Audio, Audio Enhancements, Info, Transition, 
Title, Text, Generator, and Sharing inspectors. The inspectors appear in the Inspector pane in the 
upper-right corner of the Final Cut Pro main window.
interlaced video A scanning method that divides a video frame into two fields, each consisting 
of alternating odd and even lines that are scanned at different times.
IRE An analog video signal unit of measurement for luma, established by the Institute of 
Radio Engineers.
J-cut See split edit.
job Each media file added to a batch in Compressor is a job. Each job has one media file and 
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JPEG A popular image file format that lets you create highly compressed graphics files. The 
amount of compression used can be varied. Less compression results in a higher-quality image.
keyframe A control that denotes the value of a video or audio effect parameter at a particular 
point in the project. When two keyframes with different values are set in Final Cut Pro, a 
transition from one value to another is calculated, resulting in a dynamic change to that 
parameter. The word keyframe comes from the traditional workflow in the animation industry, 
where only important (key) frames of an animated sequence were drawn to sketch a character’s 
motion over time. Once the keyframes were determined, an in-between artist drew all the frames 
between the keyframes.
keying See chroma key, luma key.
Keyword Collection When you apply a keyword to a clip, a Keyword Collection is automatically 
created in the Event Library. When you select the Keyword Collection, each clip tagged with that 
keyword is displayed.
keywords Keywords add descriptive information to a clip or clip range. You can use keywords to 
organize, sort, and classify media. You can add keywords to a clip manually, and Final Cut Pro can 
also add keywords automatically during clip analysis. See also Keyword Collection.
L-cut See split edit.
linear editing Before digital video editing, programs were edited together by copying shots 
from the original source tapes to a master tape, one by one. Because the assembly was linear, any 
changes in duration made to an earlier point of the tape required reassembling the movie from 
that point forward. See also nonlinear editing.
looping A playback mode in which clips and projects go back to the beginning whenever the 
playhead reaches the end of the media. You can turn looping on or off from the View menu or by 
pressing Command-L.
lower third A television industry term for a graphic placed in the lower area of the screen, 
usually to convey details about subjects or products. A common use of lower thirds is to identify 
individuals on the screen with their names and job titles.
luma A value describing the brightness of a video image. A luma channel is a grayscale image 
showing the range of brightness across the whole clip.
luma key An effect used to key out pixels of a certain luma value (or a range of luma values), 
creating a matte based on the brightest or darkest area of an image. Keying out luma values 
works best when your clip has a large discrepancy in exposure between the areas that you want 
to key out and the foreground images you want to preserve, such as a white title on a black 
background. See also chroma key, matte.
Mail Mail is the email application that comes withOS X.
markers Markers flag a specific location in a clip with editing notes or other descriptive 
information. You can also use markers for task management. Markers are classified as standard 
markers (blue), chapter markers (orange), to-do items (red), or completed to-do items (green).
mask An image or clip used to define areas of transparency in another clip. Similar to an alpha 
channel. The color correction tools can create masks based on a color you choose or a shape you 
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matte Sometimes referred to as a holdout matte. An effect that uses information in one layer of 
video to affect another layer. Mattes are useful when you want to use one clip to selectively hide 
or reveal part of another; for example, you could use a round spotlight shape to reveal parts of 
a video layer. Matte effects can be used by themselves to mask out areas of a clip or to create 
alpha channel information for a clip in order to make a transparent border around the clip that 
can be composited against other layers. See also alpha channel, compositing.
media A generic term for elements such as movies, sounds, and pictures.
media browsers Media that you import into events in Final Cut Pro is accessed from the Event 
Library and the Event Browser, but Final Cut Pro also includes a collection of media browsers 
you can use to add clips to your project. The media browsers provide access to the effects, titles, 
and transitions supplied with Final Cut Pro as well as to video, audio, and still-image files in other 
applications on your computer. For example, you can use the Photos Browser to access video and 
still-image files in the iPhoto and Aperture libraries. Other media browsers include the Effects, 
Music and Sound, Transitions, Titles, Generators, and Themes Browsers. The media browsers 
appear in the Media Browser pane in the lower-right corner of the Final Cut Pro main window.
media handle Additional media available before a clip start point or after a clip end point.
media stems Audio or video files that are usually exported separately for audio mixing or postproduction, or to match specifications when delivering files to broadcast networks. For example, 
you may need to deliver a multitrack QuickTime file along with separate dialogue, music, and 
effects stems.
mixing The process of adjusting the audio levels of all audio clips in an edited program, 
including the production audio, music, sound effects, voiceovers, and additional background 
ambience, to turn all of these sounds into a harmonious whole.
monochrome An image presented in shades of a single color, most often as the shades of gray 
in a black-and-white image.
MP3 Refers to the MPEG-1 or MPEG-2 Audio Layer 3 compression standard and file format. Like 
AAC, MP3 uses perceptual audio coding and psychoacoustic compression to remove superfluous 
information that the human ear doesn’t hear.
MPEG (Moving Picture Experts Group) A group of compression standards for video and audio, 
which includes MPEG-1, MPEG-2, and MPEG-4.
multicam clip A set of clips grouped together and synchronized by a common sync point. You 
can use multicam clips to edit footage from multicamera shoots or other synchronized footage 
in real time. While the active angle plays in the Viewer, you can also view all angles playing 
simultaneously in the Angle Viewer and easily cut and switch between them.
Music and Sound Browser A media browser in Final Cut Pro that allows you to access your 
iTunes content as well as sound effects and loops from Final Cut Pro and iLife.
nested sequence See compound clip.
NLE Short for nonlinear editor. See also nonlinear editing.Glossary 469
nondestructive editing No matter how you edit clips in Final Cut Pro, the underlying media is 
never touched. This is known as nondestructive editing, because all of the changes and effects you 
apply to your footage never affect the original source media files. Clips represent your media, but 
they are not the media files themselves. The clips in a project simply point to (link to) the source 
media files on your hard disk. When you modify a clip, you are not modifying the media file, just 
the clip’s information in the project. Trimmed or deleted pieces of clips are removed from your 
project only, not from the source clips in your Event Library or from the source media files on 
your hard disk.
non-drop frame timecode Timecode in which frames are numbered sequentially and no 
timecode numbers are dropped from the count. When discussing NTSC video, the video frame 
rate is actually 29.97 fps, and non-drop frame timecode is off by 3 seconds and 18 frames per 
hour in comparison to actual elapsed time. See also drop frame timecode.
non-interlaced video The standard representation of images on a computer. Also referred to as 
progressive scan. The monitor displays the image by drawing lines, one after another, from top 
to bottom.
nonlinear editing A video editing method in which edits within a program can be changed 
at any time without having to re-create the entire program. When you use a nonlinear editing 
application to edit a program, all footage used is stored on a hard disk rather than on tape. This 
allows random access to all video, audio, and images as you edit. See also linear editing.
NTSC format The video standard defined by the National Television Standards Committee, the 
organization that originally defined North American broadcast standards. Analog NTSC video has 
525 interlaced lines per frame, a frame rate of 29.97 fps, and a limited color gamut. Digital NTSC 
video has a frame size of 720 x 486 pixels (720 x 480 for DV and DVD), and a frame rate of 29.97 
fps. See also PAL format.
offline editing A post-production process in which raw footage is copied and edited without 
affecting the original camera media (film, tape, or file-based media). After a program has been 
completed in the offline edit (typically using proxy media at a lower resolution), an online edit is 
performed to re-create the edit using the original media.
opacity The level of a clip’s transparency.
outgoing clip The clip a transition segues from. For example, if Clip A dissolves to Clip B, Clip A is 
the outgoing clip. See also incoming clip.
Out point See edit point.
overwrite edit In an overwrite edit, one or more source clips overwrite any clips in the primary 
storyline or a selected storyline, starting at a range selection start point or at the skimmer or 
playhead position. No clip items are rippled forward, so the duration of your project remains the 
same. Overwriting is purely duration-based and works on range selections only, irrespective of 
clip boundaries.
PAL format Acronym for Phase Alternating Line, a 25 fps (625 lines per frame) interlaced video 
format used by many European countries. Digital PAL video has a frame size of 720 x 576. See 
also NTSC format.
Photos Browser A media browser in Final Cut Pro that allows you to access your iPhoto and 
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pitch Sounds are perceived as high or low depending on their frequency, or the number of 
times per second a sound wave cycles from positive to negative and back to positive. The word 
that musicians most commonly use for frequency is pitch. The higher the frequency, the higher 
the pitch. Modifying the speed of a clip affects the pitch of the audio. Slow motion creates low 
pitch, and fast motion creates high pitch.
pixel One dot in a video or still image. The more pixels in an image, the higher the resolution.
playhead The playhead marks your project’s current position in the Timeline or the Event 
Browser. You can move the playhead by dragging it or clicking another area of the Timeline or 
Event Browser. You use the playhead to scrub, or move through your project and play it back 
from different locations. The playhead appears as a gray vertical line that is fixed in place unless 
you move it or click elsewhere. See also skimmer.
Position tool The editing tool that allows you to place items in the Timeline. You can select the 
Position tool by pressing the P key.
post-production The phase of film or video editing in which all of the production elements are 
organized, assembled, and output.
project A project provides a record of your editing decisions and the media you use. You build 
your project by adding clips and editing them in the Timeline. A project is also defined by 
its video, audio, and render properties. In most cases, Final Cut Pro manages project settings 
automatically based on the properties of the first clip you add to a project.
Project Library The Project Library contains all of the Final Cut Pro projects on your hard disk 
and on any connected external drives.
project properties A project’s default event as well as the project’s video, audio, and render 
properties. In most cases, Final Cut Pro manages project’s properties automatically based on the 
properties of the first clip you add to a project. If you must modify the project properties, choose 
video and audio project properties based on how you intend to share your final movie with your 
audience. You set a project’s properties when you create a Final Cut Pro project, and you can 
change them at any time.
proxy files You can use Final Cut Pro to transcode your original media to create proxy files, 
which are smaller files with a lower data rate. Proxy files can be used for offline editing or for 
editing when using a slower computer. Final Cut Pro creates video proxy files using the Apple 
ProRes 422 (Proxy) codec, and still-image proxy files using the JPEG format (if the original 
file doesn’t have alpha channel information) or the PNG format (if the file has alpha channel 
information). See also alpha channel.
QuickTime Cross-platform multimedia technology from Apple. Widely used for production, postproduction, and distribution of video, audio, and interactive programs.
range Instead of selecting whole clips, you can select a range within any clip in the Timeline or 
the Event Browser. You can trim range selections, mark them with ratings and keywords, and 
modify them in other ways. You can adjust the range start and end points by dragging either 
side of the selection. In the Timeline, you can also select a range that spans multiple clips. In 
the Event Browser, you can set multiple ranges within one or more clips, and you can select and 
deselect ranges after you set them.
Range Selection tool The editing tool that allows you to select a range in the Timeline. You can 
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red laser media Traditional DVD burners and players use a red laser when working with DVD 
media. Blu-ray burners and players use a blue laser when working with Blu-ray media. The blue 
color has a shorter wavelength, making it possible to store more data on a disc when compared 
to red lasers.
render To process video and audio with any applied effects or transitions, and store the result on 
disk as a render file. These render files are stored with your Final Cut Pro event and project files. 
When you publish or export a project, it is similarly rendered to create the output files.
replace edit In a replace edit, a source selection replaces a clip in your project in the Timeline. 
In contrast to overwrite edits, replacing works on whole Timeline clips only and can change the 
duration of your project.
resolution Image resolution refers to the number of pixels in an image. Resolution is expressed 
in terms of the width and height of the image in pixels (for example, 640 x 360 pixels). Higherresolution images contain more detail but also create larger files that take longer to download. 
Your electronic devices (computer, iPhone, iPad, iPod, and so on) also have screen resolution. 
Ideally, you should match the image resolution of your media to the resolution of your 
playback device.
reverb Reverberation, or reverb, refers to the reflection pattern created by bouncing sound 
waves off the surfaces—walls, ceilings, windows, and so on—of any space, or off objects within 
a space, gradually dying out until they are inaudible. Final Cut Pro includes a variety of audio 
effects that add reverb to the sound of a clip.
RGB Abbreviation for Red, Green, Blue. A color space commonly used on computers, in which 
each color is described by the strength of its red, green, and blue components. This color space 
directly translates to the red, green, and blue phosphors used in computer displays. The RGB 
color space has a very large gamut, meaning it can reproduce a very wide range of colors. This 
range is typically larger than the range that can be reproduced for broadcast.
ripple edit The default type of trim in Final Cut Pro is a ripple trim, which adjusts a clip’s start 
point or end point without leaving a gap in the Timeline. The change in the clip’s duration ripples 
outward, moving all subsequent clips earlier or later in the Timeline. Similarly, if you delete a 
clip from the Timeline, subsequent clips ripple earlier to close the gap. Ripple edits affect the 
trimmed clip, the position of all subsequent clips in the Timeline, and the total duration of 
your project.
role Metadata text labels that you assign to clips in the Event Browser or the Timeline. They 
provide a flexible and powerful way to manage your editing workflow. You can use roles in 
Final Cut Pro to organize clips in your events and projects, control the appearance of the 
Timeline, and export separate video or audio files (also known as media stems) for broadcast 
delivery, audio mixing, or post-production.
roll edit An edit that affects two clips that share an edit point. For example, if Clip A cuts to Clip 
B, a roll edit simultaneously adjusts the end point of Clip A and the start point of Clip B by the 
same amount. The overall duration of the project stays the same.
rough edit The first editing pass. The rough cut is an early version of a movie that pulls together 
its basic elements. Often, a rough edit is performed prior to adding transitions, titles, and 
other effects.
saturation A measurement of the intensity of color in the video signal.Glossary 472
scene A series of shots that take place at the same time in the same location. A series of scenes 
make up a program.
Select tool The default arrow-shaped pointer that allows you to select items in the Timeline. For 
example, you use it to select a clip or edit point. You can select the Select tool by pressing the 
A key.
sequence See project, Timeline.
shortcut menu A menu you access by holding down the Control key and clicking an item on 
the screen, or by pressing the right mouse button. Sometimes called a contextual menu.
shot A segment of continuously recorded video. A shot is the smallest unit of a program.
skimmer The skimmer lets you preview clips in the Timeline, Event Browser, or Project Library, 
without affecting the playhead position. You use the skimmer to skim, or freely move over clips 
to play back at the position and speed of the pointer. The skimmer appears as a pink vertical 
line as you move the pointer over the area you’re skimming. If you have snapping turned on, the 
skimmer turns orange when it snaps to a position.
slate A shot at the beginning of a scene, which identifies the scene with basic production 
information such as the take, date, and scene number. A clapper provides an audiovisual cue for 
synchronization when video and audio are recorded separately.
slide edit An edit in which an entire clip is moved, along with the edit points on its left and 
right. The duration of the clip being moved stays the same, but the clips to the left and right of 
it change in length to accommodate the new position of the clip. The overall duration of the 
project and of these three clips remains the same.
slip edit An edit in which the location of both start and end points of a project clip are changed 
at the same time, without changing the position or duration of the clip. This is referred to as 
slipping, because you slip the clip’s start and end points inside the available footage. The portion 
of the clip seen in the project changes, but its position in the Timeline stays the same.
Smart Collection When you search for clips in an event using the Filter window, you can save 
your results by creating a new Smart Collection that gathers clips matching the search criteria. 
Whenever a new clip that matches the Smart Collection’s search criteria is brought into the 
event, the new clip is automatically added to the Smart Collection. Clips that appear in Smart 
Collections are not duplicates. Smart Collections filter clips in an event to help you focus on the 
clips you need to use for a specific task.
snapping When the snapping feature is turned on in Final Cut Pro, items you move in the 
Timeline (including the playhead, the skimmer, and selected clips) appear to jump, or “snap,” 
directly to certain points in the Timeline. This can help you quickly line up edits with other 
items in the project. Snapping affects the functions of many of the editing tools in Final Cut Pro, 
including the Select tool, the Trim tool, the Position tool, the Range Selection tool, and the Blade 
tool. You can disable snapping when frame-by-frame precision editing is required.
sound effects Specific audio material, such as the sound of a door closing or a dog barking, from 
effects libraries or from clips you recorded. Sound effects can be used to replace sounds in the 
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source media files The original files (video, audio, and still images or graphics) that you import 
into Final Cut Pro. A clip you use in Final Cut Pro points to the location where the source media 
file is stored (either on a disk or on a camcorder, camera, or device). Changes made to clips 
within Final Cut Pro do not affect the source media files.
special effects Visual effects applied to clips and projects, such as motion effects, compositing, 
keying, and retiming effects.
spill suppression Spill suppression is a color correction operation that applies the 
complementary (opposite) color of the color that’s being made transparent to neutralize any 
green or blue fringing or light bounce that’s tinting the subject being keyed. The Spill Level slider 
controls how much spill suppression is applied to the keyed subject.
split edit Final Cut Pro allows you to set separate video and audio start and end points in an 
individual clip. These edits, known as split edits, are a common technique in most dialogue scenes 
in films and television shows. You can use split edits to introduce the sound of a new shot or 
scene before cutting to the video of that shot or scene. Conversely, you can use a split edit to 
extend the audio of a shot over a subsequent shot.
standard-definition (SD) Refers to the original NTSC and PAL video frame sizes. NTSC uses 480 
or 486 active lines per frame, and PAL uses 576 active lines. See also high-definition (HD).
stereo Short for stereophonic, in which audio contains two different channels. Audio level 
changes are automatically made to both channels at the same time. 
storylines All instances of the Timeline contain a primary storyline, which is the main sequence 
of clips that you build to create your movie. Storylines are sequences of clips connected to the 
primary storyline. You can use storylines for the same purposes as connected clips (such as 
creating cutaways, compositing titles and other graphics, and adding sound effects and music).
straight cut A cut in which both the video and audio clip items are cut at the same time.
subframe A subframe has 1/80 the duration of a video frame and is thus a more precise unit of 
reference when editing audio at the sample level.
sync (synchronization) The relationship between the image of a sound being made in a video 
clip (for example, a person talking) and the corresponding sound in an audio clip. Maintaining 
audio sync is critical when editing dialogue. In Final Cut Pro X, connected clips and compound 
clips help maintain sync in your program.
Themes Browser A media browser in Final Cut Pro that provides access to all transitions and title 
effects supplied with Final Cut Pro, grouped into related themes.
three-point editing An editing technique in which three out of four edit points are set in a 
source selection and a project. When the edit is performed, the fourth edit point is calculated 
automatically by Final Cut Pro.
through edit An edit point in which the video or audio content on either side of the edit 
is continuous.
TIFF (Tagged Image File Format) A widely used bitmapped graphics file format, developed by 
Aldus and Microsoft, that handles monochrome, grayscale, 8- and 24-bit color. Can have alpha 
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timecode A signal recorded with your video that uniquely identifies each frame. By default, 
timecode appears in Final Cut Pro in the format hours: minutes: seconds: frames. Timecode 
supports a variety of functions in Final Cut Pro, including Timeline playback, synchronizing 
video and audio clip items, navigating through projects in the Timeline, and moving and 
trimming clips.
Timeline The bottom portion of the Final Cut Pro window contains the Timeline, where you 
create your movie project by adding and arranging clips and making all your edits.
Timeline Index You can view a text-based, chronological list of the clips, keywords, and markers 
in a project using the Timeline Index. When you select an item in the Timeline Index, the 
playhead jumps to that item in the Timeline.
tint A color shade added to an image, usually to create an effect, such as sepia.
Titles Browser A media browser in Final Cut Pro that provides access to all the title effects 
included with Final Cut Pro.
toolbar The toolbar is a collection of buttons and tools located in the middle of the Final Cut Pro 
main window. The toolbar also includes the Dashboard, which displays the timecode for the clip 
selected in the Event Browser and for the playhead’s position in the Timeline.
transcode All media files use a format. Video format examples include DV, H.264, and MPEG-2. 
Video files also have a variety of properties, such as video frame size and frame rate, data rate, 
and audio sample rate. When you need to convert a media file to a different format or change its 
properties, you transcode it to the new format or properties. Compressor, an Apple application 
designed to work with Final Cut Pro, makes transcoding media files a fast and easy process.
transitions Effects that are applied to edit points to smooth out a change from clip to clip. In 
Final Cut Pro, you can choose from a variety of video transitions, such as a dissolves or wipes, or 
you can add an audio crossfade between audio clips.
Transitions Browser A media browser in Final Cut Pro that provides access to all the video 
transitions included with Final Cut Pro.
trim After you’ve assembled your clips in rough chronological order in the Timeline, you begin 
to fine-tune the cut point (or edit point) between each pair of contiguous clips. Any time you 
make a clip in a project longer or shorter, you’re trimming that clip. However, trimming generally 
refers to precision adjustments of anywhere from one frame to several seconds. If you’re 
adjusting clip durations by much larger amounts, you’re still trimming, but you may not be in 
the fine-tuning phase of editing yet. In Final Cut Pro, you can use a variety of techniques to trim 
Timeline clips and edit points, including ripple edits, roll edits, slip edits, and slide edits.
Trim tool The editing tool that allows you to trim items in the Timeline. You can select the Trim 
tool by pressing the T key.
uncompressed 8- and 10-bit 4:2:2 These video formats can be used to store 8-bit or 10-bit 
4:2:2 Y'CbCr video without employing data compression. Bypassing compression reduces the 
computer’s processing load but increases the data rate considerably. A large-capacity RAID 
storage system is typically required to work effectively with uncompressed video. In many cases, 
Apple ProRes is a better choice. The data rate of uncompressed 4:2:2 video varies according to 
frame size and frame rate. As an example, at a frame size of 1920 x 1080 and a frame rate of 29.97 
fps, the data rate is 1.0 Gbps for uncompressed 8-bit 4:2:2 video and 1.3 Gbps for uncompressed 
10-bit 4:2:2 video.Glossary 475
value slider A value slider is a type of numerical slider control that appears as a number, often 
to the right of a basic slider. There are two ways to adjust a value slider: by dragging over the 
number to decrease or increase the parameter value, or by double-clicking the number and 
entering a new value.
variable speed Speed that varies dynamically, in forward or reverse motion, in a single clip.
VCR Abbreviation for videocassette recorder. Generally refers to consumer equipment used for 
recording video from various sources. Sometimes referred to as a VTR. See also VTR.
Vectorscope A video scope in Final Cut Pro that shows the distribution of color in your image on 
a circular scale. The Vectorscope is useful for comparing the hue and intensity of colors between 
two clips for the purposes of color correction.
Video Animation Editor You can show the Video Animation Editor for clips in the Timeline 
to adjust effect parameters, create fade-ins or fade-outs, or change effects over time 
using keyframes.
Viewer When you play clips selected in the Event Browser and the Timeline, they appear in 
the Viewer.
VTR Abbreviation for videotape recorder. Generally refers to professional equipment used for 
recording video from various sources.
watermark A visible graphic or text overlay applied to an image or video clip to indicate that it 
is protected by a copyright. Watermarks are used to discourage the use of images or video clips 
without the copyright holder’s explicit permission.
WAVE (or WAV) An audio file format most commonly used for storing uncompressed linear 
pulse code modulation (LPCM) audio data.
Waveform Monitor A video scope in Final Cut Pro that displays the relative levels of luma 
and chroma in the clip currently being examined. Spikes and dips in the displayed waveforms 
correspond to light or dark areas in your picture.
widescreen Any movie presentation that has an aspect ratio wider than 4:3. In movie theaters, 
1.85 is considered standard and 2.40 is considered widescreen. For video, 4:3 is considered 
standard and 16:9 (which is almost the same aspect ratio as 1.85) is considered widescreen. See 
also 4:3, 16:9.
wipe A common type of video transition. In a wipe, the screen splits, moving from one side 
of the image to the other to gradually reveal the next shot. A wipe is more obvious (and 
customizable) than a fade or cross dissolve.
XDCAM Sony optical disc format for recording DVCAM and IMX video within MXF container files. 
See also DVCAM, IMX.
XDCAM EX A member of the Sony XDCAM product family that uses MPEG-2 video compression 
with 4:2:0 chroma sampling. In contrast to XDCAM HD, XDCAM EX supports 720p and records 
full HD resolution (either 1920 x 1080 or 1280 x 720). Its maximum bit rate is 35 Mbps. Instead 
of optical discs, XDCAM EX camcorders use solid-state memory cards known as SxS cards. See 
also HDV.
XDCAM HD422 A member of the Sony XDCAM product family featuring 4:2:2 chroma sampling 
and a video bit rate of 50 Mbps. Like XDCAM EX, it uses MPEG-2 video compression at full HD 
resolution (either 1920 x 1080 or 1280 x 720). See also HDV.Glossary 476
Y'CbCr The color space in which many digital video formats store data. Three components are 
stored for each pixel—one for luma (Y) and two for color information (Cb for the blue difference 
signal and Cr for the red difference signal). Also referred to as YUV. See also pixel.
Zoom tool The editing tool that allows you to zoom in to or out of the Timeline. You can select 
the Zoom tool by pressing the Z key.
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Nouveautés de Final Cut Pro 10.0.6
Final Cut Pro 10.0.6 prévoie de nombreuses fonctionnalités nouvelles et améliorations qui sont 
abordées plus en détail ci-dessous.
Montage audio multicanal avancé
Final Cut Pro regroupe automatiquement les canaux audio en composants audio en fonction de 
la configuration des canaux pour le plan. Vous pouvez désormais développer la partie audio de 
plans pour afficher et monter des composants audio jusqu’au niveau des différents canaux. Vous 
avez la possibilité de modifier des composants audio de plusieurs façons parmi lesquelles:
• régler le volume ou le panoramique ;
• désactiver ou supprimer des plages dans un composant audio pour supprimer rapidement les 
sons indésirables;
• appliquer et régler des effets audio ;
• ajouter ou supprimer des composants audio d’un plan multicam.
Pour en savoir plus, consultez Vue d’ensemble du montage audio à la page 175.
Partage et exportation rationalisés
Le partage de votre travail une fois terminé s’avère plus simple et flexible dans 
Final Cut Pro 10.0.6. Les destinations, des séries de réglages d'exportation préconfigurés, vous 
permettent de publier rapidement un projet ou un plan sur un site web de partage, de les exporter pour les consulter sur un iPad ou un iPhone, ou de les graver sur un disque. Final Cut Pro 
est fourni avec une palette de destinations que vous pouvez modifier. Vous pouvez également 
en créer.
Le flux de production simplifié et rationalisé comprend les améliorations suivantes: 
• des menus simplifiés et consolidés que vous pouvez remplir de destinations personnalisées;
• des lots de destinations réutilisables qui permettent de partager plusieurs sorties et emplacements à la fois;
• le partage automatique des métadonnées de projet et de plan, avec la possibilité de personnaliser les métadonnées partagées;
• la prise en charge de multiples comptes sur des sites web de partage de vidéo tels que 
YouTube ;
• un partage et une exportation plus rapides en s’appuyant sur le traitement en arrière-plan et 
sur le processeur graphique ;
• Partage d'une plage sélectionnée dans un projet dans la timeline ou dans un plan situé dans 
le navigateur d’événements.
Pour en savoir plus, consultez Présentation du partage de projets à la page 394.
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Importation unifiée
D’emploi plus simple, la nouvelle fenêtre unifiée Importation des médias offre un même emplacement pour tous vos besoins en importation. Final Cut Pro 10.0.6 propose des zones dédiées 
pour les caméras et les appareils branchés, à système de fichiers comme à bande, ainsi qu’une 
nouvelle section Favoris, où il vous est possible d’ajouter les dossiers fréquemment utilisés 
pour l’importation de fichiers à partir de votre disque dur ou d’un lecteur externe. Parmi les 
autres nouvelles fonctionnalités d’importation, l’on retrouve aussi la présentation par liste pour 
pouvoir consulter plusieurs colonnes de métadonnées, la sélection de plusieurs plages dans 
des plans précis à partir de caméras à système de fichiers, ainsi que des outils de gestion des 
archives complets.
Pour en savoir plus, consultez Présentation de l’importation à la page 21.
Double visualiseur
Le visualiseur d’événements représente un affichage vidéo distinct à côté du visualiseur principal 
de façon à pouvoir comparer les plans et faire ainsi correspondre les animations et les couleurs. 
En ouvrant le visualiseur d’événements et le visualiseur, vous pouvez ainsi afficher deux plans 
simultanément : l’un dans le navigateur d’événements et l’autre dans la timeline, chacun avec un 
instrument vidéo propre.
Pour en savoir plus, consultez Lecture et survol du média dans le visualiseur d’événements à la 
page 83.
Prise en charge native de REDCODE RAW (R3D)
Final Cut Pro 10.0.6 assure la prise en charge native des fichiers REDCODE RAW (R3D). Vous 
pouvez à présent importer directement des fichiers RED, réaliser des ajustements de réglages 
RAW non destructifs et enregistrer ces ajustements sous forme de métadonnées, le tout depuis 
Final Cut Pro. Cela vous permet de tirer parti de tout l’éventail dynamique des options qu’offrent 
les fichiers sources REDCODE RAW.
Pour en savoir plus, consultez Importation et réglage de fichiers vidéo REDCODE RAW à la 
page 46.
Sélections de plage améliorées
Les points de départ et d’arrivée des plans dans le navigateur d’événements restent désormais 
en place lorsque vous cliquez ailleurs. Vous pouvez également effectuer des sélections de plage 
multiples dans un ou plusieurs plans. 
Pour en savoir plus, consultez Sélection d’une plage à la page 100 et Gestion de plusieurs sélections de plage dans des plans d’événement à la page 103.
Autres fonctionnalités utiles
• Les marqueurs de chapitre et vignettes de marqueurs de chapitre vous permettent de préparer des chapitres et leur image d’affiche représentative directement depuis Final Cut Pro pour 
la sortie sur DVD, sur disque Blu-ray, vers iTunes, QuickTime Player et vers les dispositifs Apple.
• La nouvelle fenêtre Coller les attributs offre un moyen puissant de transférer des effets précis 
et autres réglages entre des plans.
• Il vous est à présent possible, rapidement et en toute simplicité, d’ajouter des images figées à 
l’aide d’un simple raccourci clavier.
• L’ajout de titre est considérablement amélioré, notamment par la prise en charge de la nouvelle fonctionnalité des marqueurs de titre dans Motion.Chapitre 1 Nouveautés de Final Cut Pro ? 12
• Les points de connexion adaptables améliorent le contrôle manuel sur les plans connectés au 
cours de vos manipulations de coulissement, de glissement ou de déplacement de plans dans 
le scénario principal.
• La nouvelle architecture des plans composés simplifie leur réutilisation dans plusieurs projets 
et offre de meilleures performances.
• Vous pouvez désormais importer et exporter des fichiers MXF à l'aide de modules de tierce 
partie. Pour retrouver la liste des fichiers multimédias pris en charge, consultez Formats de 
média pris en charge à la page 45.
• Final Cut Pro 10.0.6 offre une prise en charge des données anamorphosées améliorée.
Nouveautés de Final Cut Pro 10.0.3
Final Cut Pro 10.0.3 prévoie des nouvelles fonctionnalités et des améliorations importantes qui 
sont abordées plus en détail ci-dessous.
Montage multicam
Il vous est à présent possible d’exploiter des plans multicam pour monter le métrage de prises 
multicaméra ou tout autre métrage synchronisé en temps réel. L’utilisation de plans multicam 
dans Final Cut Pro assure un processus polyvalent et fluide. Alors que les angles actifs se reproduisent dans le visualiseur, vous pouvez également visionner tous les angles simultanément dans 
le visualiseur d’angle, puis effectuer des coupes et passer facilement d’un angle à l’autre. Vous 
pouvez créer des plans multicam issus de sources de média diverses et modifier des plans existants lors du montage.
Pour en savoir plus, consultez Présentation du montage multicam à la page 320.
Sortie A/V
Vous avez à présent la possibilité de relier votre ordinateur à un moniteur externe pour la sortie 
vidéo et audio (A/V). En plus de pouvoir vérifier à quoi la vidéo et l’audio ressemblent sur un 
moniteur broadcast NTSC/PAL ou HD, cette fonctionnalité vous permet également de tester la 
sortie sur des dispositifs plus sophistiqués, tels que des vecteurscopes et des oscilloscopes.
La sortie A/V n’est disponible que sous OS X Lion 10.7.2 ou ultérieur et nécessite une interface 
vidéo matérielle et logicielle de tierce partie compatible. Les appareils DV FireWire ne sont pas 
pris en charge. Pour en savoir plus, contactez le fabricant de l’équipement ou accédez à la page 
web des ressources Final Cut Pro X à l’adresse http://www.apple.com/fr/finalcutpro/resources.
Pour en savoir plus, consultez Lecture sur un moniteur externe à la page 85.
Reconnexion manuelle de plans à des fichiers de média
Vous avez désormais la possibilité de reconnecter manuellement des plans d’événements et des 
plans de projet à des fichiers de média. La reconnexion manuelle vous permet un contrôle supé-
rieur sur votre flux de production de postproduction. 
Pour en savoir plus, consultez Reconnexion de plans à des fichiers de média à la page 410.
Autres fonctionnalités utiles
• Les fichiers graphiques multicouches, tels que les fichiers au format Adobe Photoshop (PSD), 
peuvent à présent être montés de sorte que chaque couche se présente sous la forme d’un 
plan connecté dans la timeline.
• Des commandes pour l’incrustation avancée ont été ajoutées.
• Les commandes pour l’animation avec des images clés ont été améliorées dans les éditeurs 
d’animation vidéo et audio.Chapitre 1 Nouveautés de Final Cut Pro ? 13
Nouveautés de Final Cut Pro 10.0.1
Final Cut Pro 10.0.1 bénéficie de nombreuses améliorations, modifications et fonctions inédites. 
Les fonctions les plus significatives sont présentées ci-dessous.
Rôles
Les nouvelles étiquettes de métadonnées correspondant aux rôles vous permettent d’organiser les plans dans vos événements et vos projets, de contrôler l’apparence de la timeline et 
d’exporter des fichiers vidéo ou audio séparés (également appelés stems multimédia) destinés 
au mixage audio, à la postproduction ou aux réseaux de diffusion. Vous pouvez ainsi exporter des 
rôles sous forme de stems multimédias dans un fichier QuickTime multipiste combiné ou dans 
des fichiers audio ou vidéo séparés. Durant le processus d’exportation, vous pouvez attribuer des 
sorties mono, stéréo ou Surround à vos canaux audio.
Pour en savoir plus, consultez Présentation des rôles à la page 310 et Préférences de destinations à la page 441.
Emplacements de stockage en réseau (SAN)
Vous pouvez désormais ajouter des volumes de réseau comme emplacements de stockage 
d’événements et de projets. Supprimer des emplacements SAN dans Final Cut Pro permet 
aux autres utilisateurs du réseau de travailler sur les événements et projets stockés sur 
ces emplacements.
Pour en savoir plus, consultez Utilisation d’emplacements SAN pour des événements et des projets à la page 428.
Importation et exportation de fichiers XML
Final Cut Pro prend désormais en charge l’importation et l’exportation de fichiers XML, afin que 
vous puissiez échanger vos données de projet et d’événement avec d’autres systèmes et applications tierces ne reconnaissant pas les projets et événements Final Cut Pro. 
Pour en savoir plus, consultez Utilisation de fichiers XML pour transférer des projets et des événements à la page 319.2
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Qu’est-ce que Final Cut Pro ?
Final Cut Pro X constitue une application révolutionnaire conçue pour la création, le montage 
et la production de vidéo d’une qualité optimale. Final Cut Pro associe un montage numérique 
offrant d’excellentes prestations et une prise en charge native de pratiquement tous les formats 
vidéo à l’aide de fonctionnalités simples d’emploi et puissantes, vous permettant ainsi de vous 
concentrer sur le récit de l’histoire.
Dans Final Cut Pro, vous pouvez :
• monter du métrage, allant de la vidéo en définition standard sans compression à de la vidéo 
HDV en passant par le format DVCPRO HD et la vidéo haute définition non compressée, ainsi 
que les formats AVC-Intra, AVCHD et XDCAM HD;
• reproduire et effectuer le survol de média indépendamment de sa résolution pouvant aller 
jusqu’à 1920 x 1080, 2K, 4K mais aussi 5K ; mais aussi lire de la vidéo en plein écran ou sur un 
deuxième écran ;
• disposer des plans en toute simplicité au moyen de la timeline magnétique qui replace instantanément les plans autour de celui que vous faites glisser, afin d’éviter les vides, les collisions 
et les problèmes de synchronisation ;
• monter rapidement à l’aide du jeu complet d’outils de montage et de coupe professionnels, 
ainsi que régler plus finement vos modifications avec l’éditeur de précision incorporé ;
• analyser votre vidéo dans Final Cut Pro et procéder à la correction non destructive de problèmes courants, tels que les tremblements de caméra, le bourdonnement excessif ou un 
son saturé (tonalité), mais aussi laisser Final Cut Pro détecter la présence de personnes ou du 
type de plan et appliquer automatiquement des mots-clés, par exemple Une personne ou 
Plan élargi ;
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• organiser votre média à l’aide de collections de mots-clés pour regrouper automatiquement 
les plans d’après des mots-clés, et de collections intelligentes pour regrouper automatiquement les plans en s’appuyant sur des critères de votre choix ;
• tester des plans de votre projet en utilisant des auditions, des ensembles de prises, d’effets ou 
de traitements textuels alternatifs, puis de choisir le plan le mieux adapté au montage ;
• créer des plans composés pour regrouper des combinaisons particulières de plans et en imbriquer à d’autres; 
• utiliser des plans connectés et des scénarios pour ajouter des plans de coupe, des titres superposés et des effets sonores à votre projet – les plans connectés et les scénarios restant ainsi 
toujours synchronisés;
• ajouter des effets spéciaux à la vidéo, à l’audio et à des photos, et les ajuster grâce à des 
images clés et des commandes à l’écran, mais aussi adapter la vitesse des plans pour créer des 
effets d’animation rapide ou lente ;
• adapter la balance et la correspondance des couleurs automatiquement ou faire appel 
aux outils d’étalonnage pour contrôler précisément l’apparence d’un plan quelconque de 
votre projet ;
• publier votre projet directement vers des sites web comme YouTube et Facebook ou l’envoyer 
à iTunes en vue de sa synchronisation avec des dispositifs Apple tels que l’iPhone, l’iPad et 
l’Apple TV.
Vue d’ensemble des flux de production Final Cut Pro X.
Pour donner un aperçu des possibilités qui vous sont offertes, le processus général pour monter 
un film dans Final Cut Pro est décrit ci-dessous. Toutes les étapes ne sont pas nécessaires et 
d’autres non répertoriées sont en outre possibles. Le flux de production n’est pas obligatoirement séquentiel. Vous pouvez par exemple suivre l’intégralité des effets de montage et d’ajout, 
puis importer du média complémentaire dans votre projet.
Importation de votre média dans Final Cut Pro
Pour utiliser Final Cut Pro, vous devez transférer votre média (vidéo, audio et images fixes) de 
votre dispositif d’enregistrement sur votre ordinateur ou sur un disque externe. Il vous est possible d’importer du média à partir de nombreux types de caméras et autres matériels, ou d’autres 
applications telles qu’iMovie.
Organisation de votre média
Final Cut Pro organise automatiquement votre média sous forme d’événements après son 
importation. Un événement s’apparente à un dossier contenant l’intégralité du média enregistré 
à une certaine date. Dans Final Cut Pro, votre média apparaît sous forme de plans connectés aux 
fichiers de média stockés sur disque. Vous pouvez réorganiser vos plans en créant ou en réattribuant un nom aux événements, puis en déplaçant les plans entre les événements. Par exemple, 
vous pouvez créer un événement pour l’intégralité du plan de média pour un client donné.
Au cours du passage en revue de votre métrage, vous avez la possibilité d’attribuer en toute simplicité un classement, Favori ou Rejeté, aux plans. Ces évaluations simplifient le processus dans 
la mesure où vous n’avez alors plus qu’à vous concentrer sur le métrage approprié. Final Cut Pro 
propose également d’autres moyens d’organisation pratiques, tels que les collections de motsclés et les collections intelligentes.Chapitre 2 Notions élémentaires Final Cut Pro 16
Création d’un projet et ajout de plans
Votre projet représente le film que vous créez par le biais de plans tirés de vos événements et 
des navigateurs multimédias de Final Cut Pro. Créez tout d’abord votre film en ajoutant des plans 
sur la timeline. Tous vos montages s’effectuent dans le projet ; vos fichiers de média d’origine 
sont conservés (ce que l’on entend par montage non destructif).
Arrangement et modification de plans
Votre film peut dès lors commencer à prendre forme. Pour assembler un montage brut, réorganisez et effectuez le trim des plans présents sur la timeline. Vous pouvez aussi essayer différents 
plans à l’aide d’auditions. Utilisez des plans connectés et des scénarios pour ajouter des plans 
de coupe, des titres, de la musique de fond et des effets sonores à votre projet. Créez des plans 
composés pour regrouper des combinaisons particulières de plans et en imbriquer à d’autres. 
Vous pouvez simplifier un projet qui s’avère complexe en créant un plan composé distinct pour 
chaque section principale. 
Ajout d’effets et de transitions
Ajoutez des effets spéciaux issus d’un éventail ample d’effets vidéo et audio dans les navigateurs 
multimédias de Final Cut Pro. Apportez à votre film des titres et un générique, et appliquez des 
transitions vidéo ou audio. Adaptez les réglages de vitesse des plans pour créer des effets d’accé-
lération ou de ralenti. 
Pour peaufiner votre projet, affinez les coupes et les transitions à l’aide de l’éditeur de précision, 
animez des effets vidéo et audio avec des images clés, étalonnez l’image et élaborez des images 
animées composites.
Partage d’un film
Une fois votre projet terminé, vous avez la possibilité de le publier directement depuis 
Final Cut Pro sur le Web ou l’envoyer à iTunes, un iPhone, un iPad, un iPod ou une Apple TV. Vous 
pouvez aussi graver un disque pour le distribuer.
Vue d’ensemble de l’interface Final Cut Pro X.
La fenêtre de Final Cut Pro se divise en trois zones principales:
Visualiseur : lisez des 
plans et des projets.
Navigateur d’événements : accédez à 
tous les médias source importés.
Timeline magnétique : réalisez le montage 
de votre film dans cette zone.Chapitre 2 Notions élémentaires Final Cut Pro 17
Organisation de média dans la bibliothèque d’événements et dans le navigateur d’événements
L’intégralité de votre média importé est accessible dans la bibliothèque d’événements. (Un événement s’apparente à un dossier renfermant des plans.)
Lorsque vous sélectionnez un événement dans la bibliothèque d’événements, ses plans apparaissent dans le navigateur d’événements à droite.
Navigateur d’événements : 
affichez et organisez les plans 
dans l’événement sélectionné.
Bibliothèque d’événements : 
sélectionnez un événement pour afficher 
les médias qu’il contient sur la droite.
Il vous est possible de réorganiser votre média comme bon vous semble à tout moment ; la 
bibliothèque d’événements et le navigateur d’événements vous permettent de gérer, d’attribuer 
un classement, de trier et d’associer des mots-clés à votre média importé. Pour en savoir plus, 
consultez Présentation des événements et des plans à la page 55. 
Reproduction de plans et de projets dans le visualiseur
Le visualiseur constitue le point où vous reproduisez votre vidéo, notamment les plans et les 
projets jusqu’à une résolution 1920 x 1080, 2K, 4K mais aussi 5K. Vous pouvez effectuer la lecture 
d’événements, de projets ou de plans précis en plein écran ou sur un deuxième écran. En ouvrant 
le visualiseur d’événements, correspondant à l’affichage vidéo à part qui peut s’afficher à côté du 
visualiseur principal, vous pouvez ainsi afficher deux plans simultanément : l’un dans le navigateur 
d’événements et l’autre dans la timeline. Pour obtenir des informations sur les manières de reproduire les données, reportez-vous à la section Lecture du média à la page 79.
Lecture sans distinction de 
résolution : lisez des fichiers 
vidéo jusqu’à 5K.
Lecture en plein écran : lisez vos 
vidéos en plein écran ou sur un 
second moniteur.
Commandes à l’écran : 
ajustez les effets tels que 
Transformation, Rognage et 
Distorsion.
Double visualiseur : affichez côte 
à côte les plans d’événement et les 
plans du projet.Chapitre 2 Notions élémentaires Final Cut Pro 18
Vous pouvez en outre faire appel aux commandes à l’écran superposées à la vidéo dans le visualiseur pour adapter les réglages de sorte à tirer parti d’un large éventail d’effets et de transitions.
Montage de votre projet dans la timeline magnétique
La partie inférieure de la fenêtre de Final Cut Pro reprend la timeline où vous pouvez créer votre 
film en ajoutant et en arrangeant les plans, mais aussi en y effectuant tous vos montages. La 
timeline de Final Cut Pro replace « magnétiquement » les plans autour de ceux que vous déplacez . Les vides laissés par les plans que vous déplacez par glissement sont automatiquement 
comblés par les plans avoisinants.
Un projet Final Cut Pro héberge l’intégralité des informations pour votre film final, notamment 
vos décisions de montage, et relie ces renseignements à tous les plans source et aux événements. Pour en savoir plus sur le montage d’un projet, consultez Présentation de l’ajout de 
plans à la page 106 et Disposition des plans dans la timeline à la page 124.
Barre d’outils : effectuez 
les tâches courantes en 
cliquant sur un bouton.
Plans connectés : ajoutez des titres et des 
plans de coupe. Tout reste synchronisé 
dans la timeline magnétique.
Plans audio : ajoutez de la musique 
et des effets sonores sous forme de 
plans connectés.
Scénario principal : ajoutez 
et organisez des plans pour 
créer votre séquence.
Fichiers de média et plans
Après avoir importé le média dans Final Cut Pro, les plans représentant les fichiers de média 
source apparaissent dans le navigateur d’événements. Un événement volumineux peut inclure 
de nombreux plans.
Les fichiers de média constituent la matière première avec laquelle vous créez votre projet. Un 
fichier de média représente un fichier vidéo, audio ou graphique stocké sur le disque dur, qui 
contient le métrage transféré d’un caméscope, d’un équipement d’enregistrement ou créé au 
départ sur votre ordinateur. Les fichiers de média peuvent contenir plusieurs composants vidéo 
et audio. Comme les fichiers de données (plus particulièrement les fichiers vidéo) ont tendance 
à occuper beaucoup d’espace, les projets exploitant un métrage conséquent requièrent un ou 
plusieurs disques durs de grande capacité.Chapitre 2 Notions élémentaires Final Cut Pro 19
Les plans représentent votre média mais ne sont pas des fichiers de média en tant que tels. Les 
plans dans un projet pointent simplement sur des fichiers de média source se trouvant sur votre 
disque dur. Si vous modifiez un plan, vous ne modifiez en fait pas le fichier de média en tant que 
tel mais simplement les informations liées au plan dans le projet. Cette méthode est connue sous 
le nom de montage non destructif, car l’ensemble des modifications et des effets appliqués aux 
plans dans Final Cut Pro n’a aucun effet sur les données elles-mêmes. Les parties élaguées ou 
effacées des plans ne sont supprimées que de votre projet et non des plans source qui s’affichent 
dans votre bibliothèque d’événements ou des fichiers multimédias source stockés sur votre 
disque dur.
Projet 2
Jouet1
Fichiers de média sur votre disque dur
Projet 1 Projet 3
Jouet1.mov
Jouet1
Jouet1 Jouet1
Plans de l’événement
Événements et projets
Dans Final Cut Pro X, vous pouvez utiliser des événements pour recueillir et organiser le média. 
Les événements s’apparentent à des dossiers qui contiennent le média non modifié et importé 
d’une caméra ou de toute autre source.
Les projets vous permettent de modifier et de structurer des films pour les partager avec votre 
public. Un projet représente un enregistrement du travail que vous effectuez dans la timeline 
mais aussi les décisions que vous prenez pour réaliser vos montages. Lorsque vous ajoutez un 
plan d’un événement dans un projet donné, vous établissez en fait un lien entre le plan d’évé-
nement source et le plan correspondant dans le projet (et, par extension, entre l’événement et le 
projet). Cependant, l’événement comme le plan source ne sont en fait pas contenus au sein du 
projet. Vous pouvez utiliser le plan d’événement en question dans d’autres projets et votre projet 
peut exploiter des plans issus d’autres événements.Chapitre 2 Notions élémentaires Final Cut Pro 20
L’illustration ci-dessous reprend la relation entre les événements et les projets: Final Cut Pro X 
effectue le suivi des liens entre les plans du projet et leur plan d’événement source, bien que les 
projets et les événements restent indépendants.
Projet
Projet
Événements
Événements
Événements
Événements3
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Présentation de l’importation
L’importation de médias dans Final Cut Pro constitue la première étape vers la création de votre 
film. Final Cut Pro vous permet les opérations suivantes:
• Importation d’une caméra ou d’un dispositif (sans bande) enregistrant dans des fichiers
• Importation à partir d’un iPhone, d’un iPad ou d’un iPod touch
• Importation à partir d’un caméscope ou d’un dispositif à bande
• Importation à partir d’iMovie
• Importation à partir d’iPhoto et d’Aperture
• Importation à partir d’iTunes
• Importation à partir d’un disque dur
• Importation à partir d’une archive de caméra
Lors de l’importation, vous devez assigner votre média à un événement. Vous pouvez également 
transcoder votre média et l’analyser pour y rechercher différents problèmes, tels que la balance 
des couleurs, la présence de personnes et le type de plan, ou encore régler des problèmes audio.
Lorsque vous importez des plans (vidéo, audio ou images fixes), Final Cut Pro attribue l’un des 
cinq rôles par défaut aux composants vidéo et audio de chaque plan : Vidéo, Titres, Dialogue, 
Musique et Effets. Pour en savoir plus, consultez Affichage et réattribution de rôles à la page 311.
Si vous voulez rapidement sauvegarder votre média (plutôt que suivre le processus plus lent 
d’importation), vous pouvez créer une archive.
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S’il s’agit de votre première importation
La première fois que vous ouvrez Final Cut Pro, l’application ne contient aucun média, aucun 
projet et un seul événement. Les boutons apparaissent dans le navigateur d’événements pour 
vous aider à importer rapidement des événements à partir d’iMovie, du média depuis votre 
disque dur ou un périphérique de stockage externe connecté, ou directement depuis une 
caméra branchée sur votre ordinateur.
Importation de média dans un événement vide
m Pour importer des événements d’iMovie : cliquez sur le bouton « Importer des événements iMovie » 
et suivez les instructions pour l’importation d’événements iMovie.
m Pour importer des fichiers à partir d’une caméra ou d’un disque dur: cliquez sur le bouton Média et 
suivez les instructions pour l’importation de fichiers à partir d’une caméra à système de fichiers, 
pour l’d’un disque durd’une caméra à bande ou d’une archive de caméra.
Importation à partir des caméras connectées
Importation à partir des caméras à système de fichiers
Les caméscopes et caméras produisant des fichiers permettent d’enregistrer de la vidéo, du 
son et des images fixes. Ces types de dispositifs qui enregistrent sur des supports de stockage 
à mémoire flash, des disques durs, etc., se branchent généralement sur l’ordinateur par le biais 
d’un câble USB. Certains matériels utilisent des cartes mémoire amovibles que vous pouvez 
ensuite insérer dans votre ordinateur.
Si votre dispositif produisant des fichiers inclut une fonctionnalité pour étendre des plans, vous 
pouvez importer l’intégralité du média sous la forme d’un plan étendu.
Pour vérifier si votre appareil est compatible avec Final Cut Pro, consultez la 
page web décrivant les appareils pris en charge par Final Cut Pro X à l’adresse 
http://help.apple.com/finalcutpro/cameras/.
Importation d’un caméscope, d’une caméra ou de tout autre matériel enregistrant dans 
des fichiers
1 Procédez de l’une des manières suivantes:
• Connectez votre caméscope, votre caméra ou tout autre appareil à votre ordinateur à l’aide du 
câble fourni avec le matériel en question, puis allumez-le.Chapitre 3 Importation de média 23
Si vous utilisez un caméscope, faites-le passer en mode de connexion PC. (Le nom de ce 
mode de transfert varie selon le modèle de votre matériel.) Il se peut que votre caméscope 
passe automatiquement en mode de « connexion » si vous activez le mode lecture lorsqu’il 
est connecté à votre ordinateur. Pour en savoir plus, consultez la documentation fournie avec 
votre caméscope.
Remarque : Si vous connectez un caméscope DVD à votre Mac, il se peut que l’application 
Lecteur DVD s’ouvre. Si cela se produit, il vous suffit de fermer l’application.
• Retirez la carte mémoire du caméscope ou de l’appareil, puis insérez-la dans le logement pour 
carte de votre Mac (si celui-ci en possède un) ou dans un lecteur de carte externe.
Pour en savoir plus sur les cartes mémoires, reportez-vous à la section À propos des cartes 
mémoire et des câbles à la page 43.
2 Pour ouvrir la fenêtre Importation des médias, procédez de l’une des manières suivantes:
• Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
• Cliquez sur le bouton Média à l’extrémité gauche de la barre d’outils.
3 Au besoin, sélectionnez votre caméscope, caméra ou dispositif dans la section Caméras 
de gauche.
La fenêtre Importation des médias affiche alors l’intégralité du média présent sur votre matériel. 
Dans cette fenêtre, vous pouvez effectuer le preview du média soit en lançant sa lecture à l’aide 
des commandes de lecture, soit en en effectuant le survol en déplaçant horizontalement le pointeur sur une pellicule. 
Modifiez l’apparence des plans à 
l’aide de ces commandes.
Le média sur le support 
s’affiche à cet endroit.
Commandes de lecture
Remarque : La plupart des caméras numériques modernes sont en mesure d’enregistrer indiffé-
remment des images fixes ou de la vidéo. Dans de nombreux cas, les plans vidéo et les images 
fixes de ces caméras apparaissent côte-à-côte dans la fenêtre Importation des médias.Chapitre 3 Importation de média 24
4 Procédez de l’une des façons suivantes:
• Pour changer d’appareil à partir duquel importer: cliquez sur l’appareil voulu dans la 
section Caméras.
• Pour changer la façon dont les plans apparaissent: cliquez sur le bouton Apparence du plan 
situé dans le coin inférieur droit de la fenêtre Importation des médias.
• Pour passer de la présentation en pellicule à la présentation par liste : cliquez sur les boutons 
Présentation par liste et Présentation en pellicule en bas de la fenêtre Importation des médias. 
(Caméras à système de fichiers et archives de caméra uniquement.)
Remarque : Lorsque vous sélectionnez un plan dans la présentation par liste, la pellicule du 
plan sélectionné s’affiche en haut du navigateur d’événements. La pellicule est totalement 
interactive. Elle permet d’accéder aux points de départ et d’arrivée, aux marqueurs et aux 
mots-clés.
• Pour trier des plans dans la présentation en liste d’après des données, par exemple d’après la 
durée, la date de création, le classement, un mot-clé, etc. : cliquez sur les en-têtes de colonnes 
en haut de la présentation par liste. Pour en savoir plus sur la présentation par liste, consultez 
Importation à partir d’un disque dur à la page 37.
• Pour ajouter des dossiers de média fréquemment utilisé à la section Favoris: faites-les glisser de la 
présentation par liste.
Pour supprimer un dossier de la section Favoris, cliquez sur le dossier tout en maintenant 
la touche Contrôle enfoncée, puis choisissez « Supprimer de la barre latérale » dans le 
menu contextuel.
• Pour fermer automatiquement la fenêtre Importation des médias au début de l’importation : 
cochez la case « Fermer la fenêtre après le début de l’importation ».
• Pour ajouter un dossier à la présentation en liste en le faisant glisser: faites glisser le dossier du 
Finder sur la présentation par liste, puis parcourez son contenu en présentation par liste.
5 Procédez de l’une des manières suivantes:
• Pour importer tous les plans: cliquez sur Tout importer.
• Pour importer uniquement certains plans: sélectionnez chaque plan à importer en cliquant sur 
chaque plan tout en maintenant la touche Commande, puis cliquez sur Importer la sélection 
(le bouton Importer change de nom).
Conseil : Pour sélectionner plusieurs plans regroupés, vous pouvez les encadrer en faisant glisser le pointeur de sorte à former le rectangle de sélection.
• Pour importer certaines parties de plans: faites glisser le curseur à l’intérieur de la pellicule pour 
sélectionner la plage d’images de votre choix, puis cliquez sur Importer la sélection. Vous 
pouvez également sélectionner plusieurs plages dans chaque plan. Pour en savoir plus, consultez Sélection d’une plage à la page 100.
Conseil : Vous pouvez également sélectionner un plan, appuyez sur la barre d’espace pour le 
lire et appuyez sur la touche I pour définir un point de départ ou sur la toucheO pour définir 
un point d’arrivée.
6 Dans la fenêtre qui apparaît, choisissez comment vous voulez organiser les médias importés dans 
la bibliothèque d’événements:
• Pour ajouter les plans importés à un événement existant: sélectionnez « Ajouter à l’événement 
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• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, Mariage de Paul et Sandra) dans le champ de texte, puis choisissez le disque sur 
lequel vous voulez stocker l’événement dans le menu local « Enregistrer dans ».
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
7 Si vous comptez organiser votre média, le créer du média optimisé ou proxy, analyser la vidéo ou 
analyser l’audio, cochez les cases correspondantes.
Si vous ne configurez pas Final Cut Pro de sorte à analyser votre média pendant l’importation, vous pouvez analyser les plans ultérieurement (le cas échéant) depuis le navigateur 
d’événements.
8 Cliquez sur Importer.
Par défaut, la fenêtre Importation des médias se ferme lorsque vous cliquez sur Importer. Vous 
pouvez commencer à travailler sur vos plans dans le navigateur d’événements. Final Cut Pro 
importe votre média en arrière-plan.
Si vous avez sélectionné des options à l’étape précédente, Final Cut Pro transcode et optimise 
alors les fichiers à l’issue du processus d’importation. Vous pouvez voir la progression des tâches 
d’importation et autres tâches en arrière-plan dans la fenêtre Tâches d’arrière-plan. 
9 Lorsque des tâches en arrière-plan sont terminées, débranchez le caméscope, la caméra ou 
l’appareil.
Vous pouvez créer une archive à partir de votre caméra ou équipement à système de fichiers ou 
à bande. Pour en savoir plus, consultez Création et gestion des archives de caméra à la page 429.
Réimportation d’un plan
Deux cas de figure permettent d’assurer une réimportation correcte d’un plan :
• Si le plan ne s’est pas entièrement importé : si vous annulez l’opération ou fermez Final Cut Pro 
avant la fin de l’importation, une icône représentant une caméra apparaît dans le coin inférieur 
gauche du plan. Cette icône indique que Final Cut Pro exploite le média présent sur la caméra 
pour effectuer la lecture (plutôt qu’utiliser le fichier QuickTime créé au cours de l’importation).
Icône de caméra
Pour reproduire un plan présentant une icône de caméra, Final Cut Pro recherche le média soit 
sur une caméra connectée, soit dans une archive de caméra accessible. (Consultez Accès aux 
médias sur une archive ou une image disque à la page 40 pour en savoir plus.) Si Final Cut Pro 
ne parvient pas à localiser le média dans l’un de ces emplacements, le plan est alors déconnecté et une icône d’avertissement indique qu’une caméra est absente.
• Si le fichier de média source du plan est indisponible : s’il a été déplacé ou supprimé, ou si le 
volume sur lequel il se trouve est déconnecté de l’ordinateur, une icône représentant un 
fichier manquant apparaît sur le plan. Pour rétablir le plan, vous pouvez le réimporter.
Reportez-vous à Icônes d’avertissement à la page 432 pour en savoir plus sur les icônes 
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Lorsque vous réimportez un plan, Final Cut Pro se connecte automatiquement à la caméra ou à 
l’archive de caméra nécessaire. Il n’y a alors aucun besoin d’effectuer le montage manuel d’une 
archive de caméra avant de réaliser la réimportation. 
1 Procédez de l’une des manières suivantes:
• Branchez la caméra contenant le plan sur votre ordinateur, puis allumez-la. Ceci permet 
de connecter le plan, même si celui-ci dénote toujours une icône de caméra dans le coin 
inférieur gauche.
• Insérez dans l’ordinateur ou un lecteur de carte connecté la carte mémoire incluant le plan.
Consultez À propos des cartes mémoire et des câbles à la page 43 pour en savoir plus.
• Assurez-vous que l’archive de caméra contient bien le plan stocké dans l’une des archives de 
caméra Final Cut Pro.
Consultez Création et gestion des archives de caméra à la page 429 pour en savoir plus.
2 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Pour réimporter un plan : Sélectionnez le plan dans le navigateur d’événements.
• Pour réimporter tous les plans dans un événement: Sélectionnez l’événement dans la bibliothèque d’événements.
3 Choisissez Fichier > Importer > Réimporter de l’archive/caméra.
Le ou les plans sont alors réimportés.
Importation de plans étendus
Certains caméscopes ou dispositifs produisant des fichiers et disposant de plusieurs logements 
pour carte mémoire peuvent enregistrer un plan sur plusieurs cartes mémoire. Le plan ainsi créé 
est appelé un plan étendu.
Un bon moyen pour importer un plan étendu dans Final Cut Pro consiste à connecter votre 
caméra ou votre lecteur de cartes à votre ordinateur et à créer une archive de caméra pour 
chaque carte mémoire. Vous pouvez stocker les archives de caméra sur votre ordinateur ou sur 
un dispositif de stockage externe, jusqu’à ce que vous soyez prêt à importer le plan étendu. 
(Même si vous importez le plan étendu immédiatement, il peut être utile de créer l’archive de 
caméra afin d’avoir une sauvegarde des plans qui composent le plan étendu.) Ensuite, lorsque 
vous êtes prêts pour l’importation, vous pouvez monter toutes les archives de caméra et importer le plan étendu.
Création d’une archive de caméra pour chaque carte mémoire
1 Connectez votre caméscope ou votre caméra à l’ordinateur et allumez l’appareil, ou branchez 
votre lecteur de cartes sur l’ordinateur et insérez la carte dans le lecteur. Si vous envisagez d’enregistrer les archives de caméra sur un périphérique de stockage externe, branchez également 
celui-ci.
2 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
• Cliquez sur le bouton Média à l’extrémité gauche de la barre d’outils.
La fenêtre Importation des médias apparaît. 
3 Sélectionnez une carte mémoire à archiver dans la liste des caméras à gauche.Chapitre 3 Importation de média 27
4 Cliquez sur le bouton Créer une archive situé dans le coin inférieur gauche de la fenêtre.
5 Dans le champ « Créer une archive de caméra », saisissez un nom pour l’archive.
6 Choisissez un emplacement dans le menu local Destination pour enregistrer l’archive, puis cliquez sur OK.
Remarque : Pour protéger votre média, il est recommandé d’enregistrer votre archive sur un 
disque ou une partition différente de celle sur laquelle vous stockez vos fichiers de médias utilisés avec Final Cut Pro.
7 Répétez les étapes 3 à 6 pour créer des archives de caméra pour chacune des cartes mémoire 
contenant une partie du plan étendu.
Les archives de caméra apparaissent dans la liste Archives d’appareil de la fenêtre Importation 
des médias.
Consultez Création et gestion des archives de caméra à la page 429 pour en savoir plus sur la 
création d’archives de caméra.
Importation d’un plan étendu
1 Si les archives de votre caméra sont stockées sur un périphérique de stockage externe, assurezvous que celui-ci est connecté à votre ordinateur.
2 Choisissez Fichier > Importer depuis la caméra.
La fenêtre Importation des médias apparaît, affichant toutes les archives de caméra présentes sur 
votre ordinateur (et sur tous les périphériques de stockage externes connectés) dans la section 
Archives de caméra située à gauche. 
3 Sélectionnez chacune des archives de caméra qui composent le plan étendu.
Final Cut Pro monte l’intégralité des archives de caméra. Si toutes les sections du plan étendu 
sont disponibles, toutes les archives de caméra montées affichent un plan de la même durée. 
Une icône indiquant que le plan étendu est terminé s'affiche sur le plan.
Ces archives de caméra 
contiennent toutes les 
sections du plan étendu.
Ce plan représente le plan 
étendu entier.
Cette icône indique que 
toutes les sections du plan 
étendu sont disponibles.Chapitre 3 Importation de média 28
Si des archives de caméra viennent à manquer, une icône apparaît sur le plan étendu pour 
indiquer quelle partie du plan étendu est disponible, à savoir le début, le milieu ou la fin. Vous 
pouvez sélectionner chaque archive de caméra pour connaître leurs icônes.
Indique que toutes les 
sections du plan étendu 
sont disponibles.
Indique que la section 
de fin du plan étendu est 
disponible.
Indique que la section de 
début du plan étendu est 
disponible.
Indique que la section du 
milieu du plan étendu est 
disponible.
4 Cliquez sur Tout importer pour importer le plan étendu.
Important : Si les archives de caméra qui composent le plan étendu ne sont pas toutes disponibles, vous pouvez importer chaque archive séparément. Chaque section du plan étendu est 
importée dans Final Cut Pro sous la forme d’un plan séparé.
5 Choisissez comment vous comptez organiser le média importé dans la bibliothèque 
d’événements:
• Pour ajouter les médias importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez l’événement dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, Mariage de Paul et Sandra) dans le champ de texte, puis choisissez le disque sur 
lequel vous voulez stocker l’événement dans le menu local « Enregistrer dans ».
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
6 Si vous comptez organiser votre média, le transcoder, analyser la vidéo ou analyser l’audio, 
cochez les cases correspondantes.
Si vous ne configurez pas Final Cut Pro de sorte à analyser votre média pendant l’importation, vous pouvez analyser les plans ultérieurement (le cas échéant) depuis le navigateur 
d’événements.
7 Cliquez sur Importer.
Final Cut Pro importe votre média en arrière-plan. Si vous avez sélectionné des options à 
l’étape précédente, Final Cut Pro transcode et optimise alors les fichiers à l’issue du processus 
d’importation. Vous pouvez voir la progression des tâches en arrière-plan dans la fenêtre Tâches 
d’arrière-plan.
8 Pour commencer à manipuler vos plans, fermez la fenêtre Importation des médias afin de pouvoir accéder au navigateur d’événements.Chapitre 3 Importation de média 29
Importation à partir d’un iPhone, d’un iPad ou d’un iPod touch
L’importation de média depuis un iPhone, iPad ou iPod touch est similaire à l’importation de 
fichiers à partir d’un caméscope, d’une caméra ou autre matériel.
Importation à partir d’un iPhone, d’un iPad ou d’un iPod touch
1 Connectez votre iPhone, iPad ou iPod touch à votre ordinateur à l’aide du câble Dock Connector 
vers USB livré avec l’appareil en question. (Si une autre application s’ouvre, fermez celle-ci.) 
Allumez ensuite le dispositif et déverrouillez-le.
2 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
• Cliquez sur le bouton Média à l’extrémité gauche de la barre d’outils.
La fenêtre Importation des médias apparaît.
3 Au besoin, sélectionnez votre iPhone, iPad ou iPod touch dans la section Caméras de gauche.
La fenêtre Importation des médias affiche alors l’intégralité du média présent sur votre matériel. 
Dans cette fenêtre, vous pouvez effectuer le preview du média soit en lançant sa lecture à l’aide 
des commandes de lecture, soit en en effectuant le survol en déplaçant horizontalement le pointeur sur une pellicule. 
Vous avez également la possibilité d’effectuer l’une des opérations suivantes:
• Pour changer d’appareil à partir duquel importer: cliquez sur l’appareil voulu dans la 
section Caméras.
• Pour changer la façon dont les plans apparaissent: cliquez sur le bouton Apparence du plan 
situé dans le coin inférieur droit de la fenêtre Importation des médias.
• Pour passer de la présentation en pellicule à la présentation par liste : cliquez sur les boutons 
Présentation par liste et Présentation en pellicule en bas de la fenêtre Importation des médias. 
(Caméras à système de fichiers et archives de caméra uniquement.)
Remarque : Lorsque vous sélectionnez un plan dans la présentation par liste, la pellicule du 
plan sélectionné s’affiche en haut du navigateur d’événements. La pellicule est totalement 
interactive. Elle permet d’accéder aux points de départ et d’arrivée, aux marqueurs et aux 
mots-clés.
• Pour trier des plans dans la présentation en liste d’après des données, par exemple d’après la 
durée, la date de création, le classement, un mot-clé, etc. : cliquez sur les en-têtes de colonnes 
en haut de la présentation par liste. Pour en savoir plus sur la présentation par liste, consultez 
Importation à partir d’un disque dur à la page 37.
• Pour ajouter des dossiers de média fréquemment utilisé à la section Favoris: faites-les glisser de la 
présentation par liste.
Pour supprimer un dossier de la section Favoris, cliquez sur le dossier tout en maintenant 
la touche Contrôle enfoncée, puis choisissez « Supprimer de la barre latérale » dans le 
menu contextuel.
• Pour fermer automatiquement la fenêtre Importation des médias au début de l’importation : 
cochez la case « Fermer la fenêtre après le début de l’importation ».Chapitre 3 Importation de média 30
• Pour ajouter un dossier à la présentation en liste en le faisant glisser: faites glisser le dossier du 
Finder sur la présentation par liste, puis parcourez son contenu en présentation par liste.
4 Procédez de l’une des manières suivantes:
• Pour importer tous les plans: cliquez sur Tout importer.
• Pour importer uniquement certains plans: sélectionnez chaque plan à importer en cliquant sur 
chaque plan tout en maintenant la touche Commande, puis cliquez sur Importer la sélection 
(le bouton Importer change de nom).
Conseil : Pour sélectionner plusieurs plans regroupés, vous pouvez les encadrer en faisant glisser le pointeur de sorte à former le rectangle de sélection.
• Pour importer certaines parties de plans: faites glisser le curseur à l’intérieur de la pellicule pour 
sélectionner la plage d’images de votre choix, puis cliquez sur Importer la sélection. Vous 
pouvez également sélectionner plusieurs plages dans chaque plan. Pour en savoir plus, consultez Sélection d’une plage à la page 100.
Conseil : Vous pouvez également sélectionner un plan, appuyez sur la barre d’espace pour le 
lire et appuyez sur la touche I pour définir un point de départ ou sur la toucheO pour définir 
un point d’arrivée.
5 Dans la fenêtre qui apparaît, choisissez comment vous voulez organiser les médias importés dans 
la bibliothèque d’événements:
• Pour ajouter les plans importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez l’événement dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, Mariage de Paul et Sandra) dans le champ de texte, puis choisissez le disque sur 
lequel vous voulez stocker l’événement dans le menu local « Enregistrer dans ».
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
6 Si vous comptez créer du média optimisé ou proxy, analyser la vidéo ou analyser l’audio, cochez 
les cases correspondantes.
Si vous ne configurez pas Final Cut Pro de sorte à analyser votre média pendant l’importation, vous pouvez analyser les plans ultérieurement (le cas échéant) depuis le navigateur 
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7 Cliquez sur Importer.
Par défaut, la fenêtre Importation des médias se ferme lorsque vous cliquez sur Importer. Vous 
pouvez commencer à travailler sur vos plans dans le navigateur d’événements. Final Cut Pro 
importe votre média en arrière-plan.
Si vous avez sélectionné des options à l’étape précédente, Final Cut Pro transcode et optimise 
alors les fichiers à l’issue du processus d’importation. Vous pouvez voir la progression des tâches 
d’importation et autres tâches en arrière-plan dans la fenêtre Tâches d’arrière-plan. 
8 Lorsque des tâches en arrière-plan sont terminées, débranchez l’iPhone, iPad ou iPod touch.
Importation à partir d’un appareil photo numérique
Il est possible d’importer de la vidéo et des images fixes à partir d’un appareil photo numérique. 
La procédure ci-dessous explique comment importer de la vidéo et des images fixes directement 
dans Final Cut Pro. Vous pouvez également importer vos photos dans Aperture ou dans iPhoto et 
y accéder à travers le navigateur de photos de Final Cut Pro.
Pour vérifier si votre appareil est compatible avec Final Cut Pro, consultez la 
page web décrivant les appareils pris en charge par Final Cut Pro X à l’adresse 
http://help.apple.com/finalcutpro/cameras/.
Importation de plans d’images fixes et de plans vidéo à partir d’un appareil photo numérique
1 Branchez votre caméra sur votre ordinateur à l’aide du câble fournie avec celle-ci et allumez-la.
Si votre caméra n’apparaît pas à gauche de la fenêtre Importation des médias (dans la section 
Caméras ou Appareils), retirez la carte mémoire de la caméra, puis insérez-la dans le logement 
pour carte de votre Mac (si celui-ci en possède un) ou dans un lecteur de carte externe.
2 Dans le Finder, localisez le dossier DCIM dans l’arborescence de la caméra, puis les fichiers 
d’images et de vidéos. Ces fichiers peuvent se trouver dans le dossier DCIM ou dans un dossier situé à un ou deux niveaux inférieurs. La structure des fichiers varie selon les modèles et 
les fabricants.
3 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Sélectionnez Fichier > Importer > Média (ou appuyez sur Commande + I), puis suivez les instructions de Importation à partir d’un disque dur à la page 37.
• Faites glisser les fichiers du Finder sur un événement ou sur la timeline de Final Cut Pro. Les 
fichiers sont alors importés en utilisant les réglages d’importation que vous avez définis dans 
les préférences Importation. Consultez Importation à partir d’un disque dur à la page 37.
Une fois l’importation terminée, il se peut que vous disposiez de fichiers audio utilisables pour 
remplacer la piste audio de certaines vidéos. Pour ce faire, vous pouvez automatiquement synchroniser les plans vidéo et audio.
Importation à partir des caméras à bande
Vous pouvez importer des médias à partir d’un caméscope ou d’un dispositif à bande. Pour 
déterminer quels plans vous devez importer (plutôt que de tous les importer), vous pouvez les 
visualiser dans Final Cut Pro avant de les importer.
Final Cut Pro prend en charge l'importation de contenu à bande des format multimédias suivants: DV (y compris DVCAM, DVCPRO et DVCPRO50), DVCPRO HD et HDV.
Pour vérifier si votre appareil est compatible avec Final Cut Pro, consultez la page web 
décrivant les appareils pris en charge par Final Cut Pro X à l’adresse http://help.apple.com/
finalcutpro/cameras/.Chapitre 3 Importation de média 32
Importation de médias à partir d’un caméscope ou d’un dispositif à bande
1 Connectez le caméscope à votre ordinateur par le biais du câble FireWire fourni avec votre 
caméscope et configurez votre matériel, le cas échéant, pour le contrôler à distance par FireWire.
Remarque : Pour de meilleurs résultats lors de l’importation à partir d’un caméscope à bande, 
il est recommandé d’importer la vidéo à l’aide du même caméscope que celui utilisé pour 
l’enregistrement.
2 Allumez le caméscope et mettez-le en mode magnétoscope (VTR ou VCR). (Le nom de ce mode 
peut varier selon votre modèle de caméra. Pour en savoir plus, consultez la documentation fournie avec votre caméscope.)
3 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
• Cliquez sur le bouton Média à l’extrémité gauche de la barre d’outils.
La fenêtre Importation des médias apparaît.
4 Si plusieurs matériels sont connectés à votre ordinateur, choisissez dans la liste des caméras 
située à gauche celui à partir duquel vous voulez importer.
La fenêtre Importation des médias affiche l’image de la position active de la bande.
5 Utilisez les commandes de lecture (ou les touchesJ, K et L) pour placer la bande sur le point à 
partir duquel vous voulez commencer l’importation, puis cliquez sur Importer.
6 Dans la fenêtre qui apparaît, choisissez comment vous voulez organiser les médias importés dans 
la bibliothèque d’événements:
• Pour ajouter les plans importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez l’événement dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, Mariage de Paul et Sandra) dans le champ de texte, puis choisissez le disque sur 
lequel vous voulez stocker l’événement dans le menu local « Enregistrer dans ».Chapitre 3 Importation de média 33
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
7 Si vous comptez transcoder votre média, l’organiser ou analyser l’audio, cochez les 
cases correspondantes.
Si vous ne configurez pas Final Cut Pro de sorte à analyser votre média pendant l’importation, vous pouvez analyser les plans ultérieurement (le cas échéant) depuis le navigateur 
d’événements.
8 Cliquez sur Importer.
Final Cut Pro lance immédiatement l’importation à partir de la position sur la bande. L’application 
poursuit l’importation (et enregistre les fichiers de média résultants dans l’événement que vous 
avez spécifié) jusqu’à ce que l’un des cas de figure suivants se produise :
• la fin de la bande soit atteinte ;
• Le disque dur vers lequel vous effectuez l’importation est plein.
• Vous pouvez interrompre la session d’importation en cliquant sur Arrêter l’importation ou 
Fermer (pour fermer la fenêtre Importation des médias).
La vidéo est lue pendant son importation. L’importation de la vidéo prend autant de temps que 
sa visualisation à vitesse normale.
9 Lorsque la section de la vidéo que vous voulez importer a été importée, cliquez sur Arrêter 
l’importation. Utilisez ensuite les commandes d’importation pour placer votre vidéo à un point à 
partir duquel vous voulez recommencer l’importation, puis répétez les étapes 5 à 7. Si vous avez 
sélectionné des options à l’étape 6, Final Cut Pro transcode et optimise alors les fichiers à l’issue 
du processus d’importation. Vous pouvez voir la progression des tâches en arrière-plan dans la 
fenêtre Tâches d’arrière-plan.
10 Une fois l’importation effectuée, cliquez sur Fermer pour fermer la fenêtre Importation 
des médias.
Vous pouvez en outre créer une archive à partir de votre dispositif à bande, en enregistrant le 
contenu de la bande du début à la fin et en enregistrant les plans capturés sous forme d’archive. 
Pour en savoir plus, consultez Création et gestion des archives de caméra à la page 429.
Si votre caméra ou dispositif n’est pas reconnu
Si vous avez connecté votre caméra ou caméscope à votre ordinateur mais que la fenêtre 
Importation des médias ne s’ouvre pas ou que Final Cut Pro ne contrôle pas votre dispositif, vous 
pouvez tenter plusieurs opérations pour établir la connexion.
Vérifiez votre équipement et votre ordinateur.
1 Assurez-vous que vous utilisez votre équipement dans sa configuration adéquate :
• Votre caméscope ou caméra doit être compatible avec Final Cut Pro. Pour obtenir la liste des 
appareils compatibles avec Final Cut Pro X, consultez la page web http://help.apple.com/
finalcutpro/cameras/.
• Votre appareil doit être correctement connecté à votre ordinateur.
• Votre caméscope doit être placé en mode de sortie adéquat. Sur certains caméscopes, ce 
mode est appelé le mode magnétoscope (ou encore VTR ou VCR), mais tous les caméscopes 
n’utilisent pas la même terminologie, c’est pourquoi il est nécessaire de consulter la documentation fournie avec votre matériel. Sur certains caméscopes, vous devez régler la sortie sur 
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• Si vous connectez un caméscope à bande à votre ordinateur, vous devez utiliser un câble 
FireWire (aussi appelé IEEE 1394 ou i.LINK), et non pas un câble USB.
Consultez À propos des cartes mémoire et des câbles à la page 43 pour en savoir plus.
• Si vous importez des plans vidéo à partir d’un appareil photo ou d’un autre dispositif à 
mémoire flash, assurez-vous que le format de fichier de votre vidéo est MPEG-2, MPEG-4 ou 
AVCHD, ces formats étant tous compatibles avec Final Cut Pro.
• Si votre appareil photo n’est pas pris en charge par Final Cut Pro, essayez d’importer les données sous forme de fichiers à l’aide d’un logement pour carte de votre Mac ou d’un lecteur de 
carte externe. 
Consultez Importation à partir d’un disque dur à la page 37 pour en savoir plus.
• Si vous avez activé la permutation rapide d’utilisateur, assurez-vous que personne n’essaie 
d’utiliser simultanément le caméscope depuis un autre compte.
2 Si vous n’arrivez toujours pas à importer le média après avoir vérifié les éléments ci-dessus, 
essayez les opérations suivantes:
• Éteignez puis rallumez l’appareil.
• Déconnectez le câble de l’appareil et de l’ordinateur, puis rebranchez-le.
• Quittez puis rouvrez Final Cut Pro.
• Redémarrez votre ordinateur.
• Essayez d’utiliser un autre câble.
• Essayez d’utiliser un autre ordinateur sur lequel Final Cut Pro est installé.
• Si vous utilisez un caméscope produisant des fichiers, utilisez le Finder pour copier le volume 
monté sur un disque local. Ouvrez ensuite les fichiers dans Final Cut Pro de la même façon que 
vous ouvrez une archive.
Remarque : Lorsque des images s’affichent en rouge avec un triangle d’avertissement jaune dans 
la timeline ou dans l’événement, Final Cut Pro vous signale en fait qu’une partie de votre projet 
ou de votre événement est manquante. Pour en savoir plus, consultez Icônes d’avertissement à la 
page 432.
Importation à partir d’autres applications
Importation à partir de Motion
Vous pouvez créer et modifier des effets vidéo, des titres, des transitions et des générateurs 
dans Motion 5 pour les exploiter dans Final Cut Pro. Si vous enregistrez un modèle dans Motion, 
celui-ci est alors « publié » et mis à disposition dans son navigateur multimédia respectif dans 
Final Cut Pro. 
Reportez-vous aux informations relatives aux modèles Final Cut Pro X dans l’Aide Motion à 
l’adresse http://help.apple.com/motion/.
Pour en savoir plus, consultez les sections suivantes: 
• Création de versions de transitions spécialisées dans Motion à la page 221
• Création de versions d’effets vidéo spécialisées dans Motion à la page 246
• Création de versions de générateurs spécialisées dans Motion à la page 250Chapitre 3 Importation de média 35
Importation à partir d’iMovie
Il vous est possible d’importer l’un de vos projets iMovie et votre bibliothèque d’événements 
iMovie dans Final Cut Pro.
Remarque : pour importer un projet de bande-annonce iMovie, vous devez au préalable le 
convertir en projet iMovie standard. Pour en savoir plus, choisissez Aide dans iMovie ‘11 et lancez 
une recherche sur les termes « Convertir une bande-annonce en projet ».
Important : les projets et plans iMovie tirés de la bibliothèque d’événements d’iMovie ne sont 
pas analysés automatiquement lors de l’importation car ils conservent leurs résultats d’analyse d’origine d’iMovie. Vous pouvez passer outre l’analyse iMovie en analysant vos plans dans 
Final Cut Pro après l’importation. Pour en savoir plus, consultez Analyser vos données à la 
page 51. 
Importer un projet iMovie
1 Dans Final Cut Pro, choisissez Fichier > Importer > Projet iMovie, puis localisez votre projet 
iMovie, généralement situé dans le dossier Vidéos de votre disque dur.
2 Cliquez sur Importer.
Le projet s’ouvre dans la timeline et tous les événements associés apparaissent dans la bibliothèque d’événements.
Importation de votre bibliothèque d’événements iMovie
1 Dans Final Cut Pro, choisissez Fichier > Importer > Bibliothèque d’événements iMovie.
2 Lisez le message qui apparaît et cliquez sur OK.
Les événements de votre bibliothèque d’événements iMovie apparaissent dans la bibliothèque 
d’événements de Final Cut Pro.
Importation à partir d’iPhoto et d’Aperture
Lorsque vous faites glisser des photos et des vidéos d’iPhoto et d’Aperture dans Final Cut Pro, 
elles sont importées en adoptant les réglages d’importation que vous avez définis dans les pré-
férences Importation. Pour en savoir plus, consultez Importation à partir d’un disque dur à la 
page 37.
Importation de photos et de vidéos à partir d’iPhoto ou d’Aperture
1 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Choisissez Fenêtre > Navigateur multimédia > Photos.
• Dans la barre d’outils, cliquez sur le bouton Photos.Chapitre 3 Importation de média 36
2 Si nécessaire, accédez à la section iPhoto ou Aperture du navigateur de photos.
3 Pour utiliser une ou plusieurs photos ou vidéos dans votre projet, faites-les glisser depuis le navigateur de photos et déposez-les sur une icône d’événement dans la bibliothèque d’événements 
ou sur un projet dans la timeline. Pour sélectionner plusieurs plans, vous pouvez cliquer dessus 
tout en maintenant la touche Commande enfoncée ou tracer un rectangle de sélection les 
englobant tous.
Vous pouvez également faire glisser des photos et des vidéos depuis iPhoto ou Aperture et les 
déposer directement sur un événement dans la bibliothèque d’événements ou un projet dans la 
timeline, sans passer par le navigateur de photos.
Importation à partir d’iTunes
Vous pouvez importer dans Final Cut Pro de la musique et du son provenant de votre 
bibliothèque iTunes.
Importation de musique et de son à partir d’iTunes
1 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Choisissez Fenêtre > Navigateur multimédia > Musique et son.
• Cliquez sur le bouton Musique et son dans la barre d’outils.
2 Dans le navigateur de musique et son, choisissez iTunes dans le menu local situé en haut.
Conseil : Si le dossier que vous recherchez n’est pas visible, vous pouvez l’ajouter à la liste 
de sources en le faisant glisser depuis le Finder ou le bureau jusque dans le navigateur de 
musique et son.
3 Dans la liste qui s’affiche, recherchez le son ou la musique que vous désirez :
• Pour rechercher un élément: saisissez votre texte dans le champ de recherche. Pour filtrer votre 
recherche, cliquez sur le bouton Filtre et choisissez le filtre souhaité.
• Pour obtenir un aperçu d’un élément: double-cliquez sur l’élément ou sélectionnez-le et cliquez 
sur le bouton Lecture .
• Pour sélectionner plusieurs éléments: cliquez sur chaque élément tout en maintenant la touche 
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4 Faites glisser le ou les fichiers de son vers la timeline.
Remarque : Pour de meilleures performances en lecture et à l’importation, Final Cut Pro transcode automatiquement tous les fichiers audio MP3 en fichiers audio WAV et conserve les fichiers 
MP3 originaux pour une utilisation ultérieure. Pour en savoir plus sur l’emplacement des fichiers 
de données originaux et des fichiers de données transcodés, consultez la section Emplacement 
de vos fichiers de média et de projet à la page 407.
Importation à partir de dispositifs
Importation à partir d’un disque dur
Vous pouvez importer des données (vidéo, audio, images et fichiers graphiques) depuis le disque 
dur de votre ordinateur, un périphérique de stockage externe connecté, une carte mémoire insé-
rée dans le logement pour carte de votre ordinateur ou un lecteur de carte, ou un volume réseau 
attaché. Vous pouvez importer des données en utilisant la fenêtre Importation des médias ou en 
faisant glisser des fichiers depuis le Finder.
Lorsque vous faites glisser des médias du Finder dans Final Cut Pro, ceux-ci sont importés d’après 
les réglages d’organisation, de transcodage et d’analyse que vous avez définis dans les préfé-
rences de Final Cut Pro. Si vous ne voulez pas utiliser la fenêtre Importation des médias pour 
gérer votre importation, et si vous voulez toujours utiliser les mêmes réglages d’organisation, de 
transcodage et d’analyse, l’importation par glisser-déposer des fichiers dans Final Cut Pro s’avère 
être une bonne solution. Consultez Préférences d’importation à la page 440 pour en savoir plus 
sur les préférences d’importation.
Remarque : Certains appareils basés sur les fichiers autorisent la copie, via le Finder, des données 
enregistrées (en respectant leur structure de répertoire originale) dans un dossier de votre ordinateur. Pour importer du média copié de cette façon, consultez Accès aux médias sur une archive 
ou une image disque à la page 40.
Importation de média d’un disque dur à partir de la fenêtre Importation des médias
1 Si le média à importer se trouve sur un périphérique de stockage externe ou une carte mémoire, 
branchez l’appareil sur votre ordinateur et mettez-le sous tension.
2 Pour ouvrir la fenêtre Importation des médias, procédez de l’une des manières suivantes:
• Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
• Cliquez sur le bouton Média à l’extrémité gauche de la barre d’outils.
3 Dans la section Appareils de gauche de la fenêtre Importation des médias, sélectionnez le disque 
dur de votre ordinateur, le périphérique de stockage externe branché ou la carte mémoire 
duquel ou de laquelle importer le média.
4 Utilisez la présentation par liste située en bas de la fenêtre pour accéder à un fichier ou à un dossier, puis sélectionnez-le. (Lorsque vous importez à partir d’un disque dur, les pellicules ne sont 
alors visibles que pour les différents plans sélectionnés.)Chapitre 3 Importation de média 38
Conseil : Cliquez tout en maintenant la touche Commande enfoncée pour sélectionner plusieurs 
fichiers ou dossiers
Ajoutez les dossiers d’importation favoris.
Accédez aux fichiers et dossiers.
Lancez la 
lecture du plan 
sélectionné.
Survolez le plan 
sélectionné.
Cliquez sur 
l’en-tête 
d’une colonne 
pour trier les 
éléments en 
fonction de 
la catégorie 
correspondante.
5 Procédez de l’une des façons suivantes:
• Pour effectuer le preview du plan sélectionné : lancez sa lecture à l’aide des commandes de lecture ou effectuez-en le survol en déplaçant horizontalement le pointeur sur la pellicule.
• Pour changer de disque dur à partir duquel importer: sélectionnez le disque dur dans la section 
Appareils ou sélectionnez l’emplacement dans la section Favoris.
• Pour trier des plans dans la présentation en liste d’après des données, par exemple d’après la durée, 
la date de création, le classement, un mot-clé, etc. : cliquez sur les en-têtes de colonnes en haut 
de la présentation par liste.
• Pour ajouter des dossiers de média fréquemment utilisé à la section Favoris: faites glisser un dossier de la liste de droite sur la section Favoris située à gauche.
Pour supprimer un dossier de la section Favoris, cliquez sur le dossier tout en maintenant 
la touche Contrôle enfoncée, puis choisissez « Supprimer de la barre latérale » dans le 
menu contextuel.
• Pour fermer automatiquement la fenêtre Importation des médias au début de l’importation : 
cochez la case « Fermer la fenêtre après le début de l’importation ».
• Pour ajouter un dossier à la présentation en liste en le faisant glisser: faites glisser le dossier du 
Finder sur la présentation par liste, puis parcourez son contenu en présentation par liste.
6 Lorsque vous êtes prêt à importer, cliquez sur Importer la sélection.
7 Dans la fenêtre qui apparaît, choisissez comment vous voulez organiser les médias importés dans 
la bibliothèque d’événements:
• Pour ajouter les plans importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez l’événement dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, Mariage de Paul et Sandra) dans le champ de texte, puis choisissez le disque sur 
lequel vous voulez stocker l’événement dans le menu local « Enregistrer dans ».
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
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8 Pour que Final Cut Pro copie vos fichiers de médias et les ajoute au dossier des événements que 
vous avez spécifié, cochez la case.
9 Si vous comptez organiser votre média, le créer du média optimisé ou proxy, analyser la vidéo ou 
analyser l’audio, cochez les cases correspondantes.
Si vous ne configurez pas Final Cut Pro de sorte à analyser votre média pendant l’importation, vous pouvez analyser les plans ultérieurement (le cas échéant) depuis le navigateur 
d’événements.
10 Cliquez sur Importer.
Par défaut, la fenêtre Importation des médias se ferme lorsque vous cliquez sur Importer. Vous 
pouvez commencer à travailler sur vos plans dans le navigateur d’événements. Final Cut Pro 
importe votre média en arrière-plan.
Si vous avez sélectionné des options à l’étape précédente, Final Cut Pro commence à transcoder 
et optimiser les fichiers à l’issue du processus d’importation. Vous pouvez voir la progression des 
tâches d’importation et autres tâches en arrière-plan dans la fenêtre Tâches d’arrière-plan. 
Si vous avez importé du média à partir d’un périphérique externe et que vous avez indiqué à 
Final Cut Pro de copier les fichiers de média dans le dossier Final Cut Events (plutôt que de simplement faire référence à leur emplacement d’origine), vous pouvez débrancher l’appareil une 
fois les tâches en arrière-plan terminées. 
Remarque : Pour en savoir plus sur la restauration d’événements et de projets à partir de copies 
de sauvegarde, consultez Sauvegarde des projets, des événements et de votre bibliothèque de 
projets à la page 421.
Importation de média par glissement depuis le Finder
Procédez de l’une des manières suivantes:
m Sélectionnez un fichier, cliquez tout en maintenant la touche Commande enfoncée pour sélectionner plusieurs fichiers ou sélectionnez un dossier de fichiers et faites-les glisser du Finder sur 
l’événement.
Le ou les plans apparaissent dans l’événement.
m Sélectionnez et faites glisser un fichier, cliquez tout en maintenant la touche Commande enfoncée pour sélectionner plusieurs fichiers, ou sélectionnez et faites glisser un dossier de fichiers du 
Finder sur une collection de mots-clés.
Le ou les plans apparaissent dans l’événement et le mot-clé est automatiquement ajouté aux 
plans en question.
Important : Si la préférence d’importation « Importer des dossiers sous forme de collections de 
mots-clés » est cochée, une collection de mot-clé est alors créée pour chaque nom de dossier et 
les fichiers dans le dossier se voient attribués ce mot-clé.
m Sélectionnez, ou cliquez tout en maintenant la touche Commande enfoncée pour sélectionner 
plusieurs fichiers, et faites glisser le ou les fichiers sur la timeline d’un projet.
Le ou les plans apparaissent dans celle-ci et dans le dossier des événements (Events) par défaut 
du projet.
Le fichier ou les fichiers sont importés en utilisant vos réglages d’importation par défaut.Chapitre 3 Importation de média 40
Accès aux médias sur une archive ou une image disque
Si vous avez créé une archive de caméra, il vous est possible d’utiliser le média stocké dans 
l’archive de deux manières:
• Vous pouvez connecter l’archive de caméra de sorte à mettre son média à disposition 
de Final Cut Pro. Bien que toutes les archives soient toujours répertoriées dans la fenêtre 
Importation des médias, il vous est impossible d’utiliser un quelconque média dans une 
archive tant que celle-ci n’est pas connectée.
• Vous pouvez importer des médias à partir de l’archive ou d’image disque archivés au préalable à l’aide de la fenêtre « Lister et transférer » de Final Cut Pro 7 ou antérieur. Ce faisant, des 
copies des médias sont créées sur votre disque local.
Remarque : Certains appareils basés sur les fichiers autorisent la copie, via le Finder, des données enregistrées (en respectant leur structure de répertoire originale) dans un dossier de votre 
ordinateur. Pour importer des médias copiés de cette façon, suivez les instructions reprises 
ci-dessous.
Importation de données à partir d’une archive ou d’une image disque
1 Pour ouvrir la fenêtre Importation des médias, procédez de l’une des manières suivantes:
• Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
• Cliquez sur le bouton Média à l’extrémité gauche de la barre d’outils.
2 Procédez de l’une des manières suivantes:
• Pour monter une archive de caméra : Dans la section Archives d’appareil située à gauche dans la 
fenêtre Importation des médias, sélectionnez une archive de caméra pour vous y connecter.
Remarque : Pour déconnecter l’archive de caméra, cliquez sur l’icône d’éjection.
Archive de caméra
• Pour monter une image disque : Dans la section Appareils de gauche de la fenêtre Importation 
des médias, sélectionnez le disque dur de votre ordinateur, le périphérique de stockage 
externe branché ou la carte mémoire duquel ou de laquelle importer le média. Utilisez ensuite 
la liste située en bas de la fenêtre pour accéder à l’image disque voulue, puis sélectionnez-la. 
L’archive (ou l’images disque) est alors connectée à Final Cut Pro et son média s’affiche dans la 
fenêtre Importation des médias.
3 Pour importer le média, consultez la section Importation à partir des caméras à système de 
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Organisation des fichiers lors de l’importation
Vous avez le choix du mode d’organisation de votre média au moment où vous l’importez dans 
Final Cut Pro.
• Copier les fichiers dans le dossier Final Cut Events: cette option duplique les fichiers de médias et 
place la copie dans le dossier Final Cut Events sur votre ordinateur. Si vous importez un média 
depuis un autre disque ou volume, ou si vous voulez conserver une copie de tous les fichiers 
de média qui ont été importés dans Final Cut Pro au même emplacement (à savoir dans le 
dossier Final Cut Events), cochez cette case.
Si vous importez des fichiers alors que la case est décochée, Final Cut Pro crée alors des 
fichiers de référence (alias de fichiers) pointant simplement sur les fichiers de média source, 
sans copier ces derniers. Au moment où vous sauvegardez des événements et des projets utilisant ces fichiers, Final Cut Pro copie uniquement les fichiers de référence (et non les fichiers de 
média source). Si après avoir sauvegardé votre projet ou événement, vous souhaitez remplacer 
les fichiers de référence par les fichiers de média source à proprement parler, sélectionnez les 
événements, puis choisissez Fichier > Organiser les fichiers d’événements.
• Importer des dossiers sous forme de collections de mots-clés: lorsque vous possédez des dossiers 
de fichiers dont les noms de dossiers sont explicites, sélectionner cette option permet de créer 
un mot-clé pour chaque nom de dossier et d’appliquer ce mot-clé à tous les fichiers du dossier 
pendant l’importation. De plus, une collection de mots-clés est créée pour chaque mot-clé. 
À l’issue de l’importation, 
ces plans incluent les 
mots-clés « B-roll » 
et « Callaways »
À l’issue de l’importation, 
ces plans incluent les 
mots-clés « Interviews » 
et « Callaways »
Organisation de fichiers pendant l’importation
1 Pour importer un fichier, choisissez Fichier > Importer > Fichiers, puis accédez au fichier 
à importer.
2 Dans la fenêtre qui apparaît, choisissez comment vous voulez organiser les médias importés dans 
la bibliothèque d’événements:
• Pour ajouter les médias importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez l’événement dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, Mariage de Paul et Sandra) dans le champ de texte, puis choisissez le disque sur 
lequel vous voulez stocker l’événement dans le menu local « Enregistrer dans ».
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
3 Sélectionnez l’une des cases d’organisation ou les deux (abordées ci-dessus).
4 Si vous comptez transcoder votre média, l’organiser ou analyser l’audio, cochez les 
cases correspondantes.
Si vous ne configurez pas Final Cut Pro de sorte à analyser votre média pendant l’importation, vous pouvez analyser les plans ultérieurement (le cas échéant) depuis le navigateur 
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5 Cliquez sur Importer.
Final Cut Pro importe votre média en arrière-plan. Si vous avez sélectionné des options à 
l’étape précédente, Final Cut Pro transcode et optimise alors les fichiers à l’issue du processus 
d’importation. Vous pouvez voir la progression des tâches en arrière-plan dans la fenêtre Tâches 
d’arrière-plan.
6 Pour commencer à manipuler vos plans, fermez la fenêtre Importation des médias afin de pouvoir accéder au navigateur d’événements.
Copie de l’intégralité des fichiers de média externes utilisés par un événement dans son dossier d’événement
1 Sélectionnez l’événement dans la bibliothèque d’événements.
2 Choisissez Fichier > Organiser les fichiers d’événements.
3 Dans la fenêtre qui s’affiche, cliquez sur Continuer.
Final Cut Pro duplique les fichiers de médias et place la copie dans le dossier Final Cut Events sur 
votre ordinateur.
Importation pendant l’enregistrement
Vous pouvez enregistrer une vidéo directement dans Final Cut Pro à l'aide d'une caméra intégrée 
à votre ordinateur ou d'une caméra externe iSight.
Enregistrement de vidéo et d’audio en direct dans Final Cut Pro
1 Procédez de l’une des manières suivantes:
• Pour enregistrer à l’aide de la caméra intégrée : cliquez sur le bouton Importer des médias dans 
la barre d’outils.
• Pour réaliser l'enregistrement à l'aide d'une caméra externe iSight: connectez la caméra iSight à 
votre ordinateur avec un câble FireWire et cliquez sur le bouton Importation de média dans la 
barre d'outils.
2 Dans la liste des caméras située dans la partie gauche de la fenêtre Importation des médias, 
sélectionnez la caméra à partir de laquelle vous souhaitez effectuer l’importation.
Une image vidéo en direct provenant de la caméra apparaît alors dans la fenêtre Importation 
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3 Cliquez sur Importer.
La fenêtre Réglages de l’événement s’affiche.
4 Choisissez comment vous comptez organiser le média importé dans la bibliothèque 
d’événements:
• Pour ajouter les médias importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez l’événement dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, Mariage de Paul et Sandra) dans le champ de texte, puis choisissez le disque sur 
lequel vous voulez stocker l’événement dans le menu local « Enregistrer dans ».
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
5 Si vous comptez organiser votre média, le créer du média optimisé ou proxy, analyser la vidéo ou 
analyser l’audio, cochez les cases correspondantes.
Si vous ne configurez pas Final Cut Pro de sorte à analyser votre média pendant l’importation, vous pouvez analyser les plans ultérieurement (le cas échéant) depuis le navigateur 
d’événements.
6 Une fois prêt pour l’enregistrement, cliquez sur Importer.
La caméra lance l’enregistrement sans délai.
7 Lorsque vous voulez arrêter l’enregistrement, cliquez sur Arrêter l’importation.
Un plan vidéo est ainsi créé. Vous pouvez cliquer sur Importer pour recommencer l’enregistrement. Vous avez la possibilité de répéter cette procédure autant de fois que nécessaire.
Conseil : Il est également possible d'enregistrer des vidéos depuis des caméscopes connectés par 
câble FireWire à l'aide de QuickTime X. Pour en savoir plus, consultez l'aide de QuickTime Player.
À propos des cartes mémoire et des câbles
Pour importer du média de votre dispositif d’enregistrement vers votre ordinateur, vous devez 
retirer la carte mémoire de votre matériel et l’insérer soit directement dans votre ordinateur, soit 
dans un lecteur de carte mémoire. Vous pouvez également connecter votre matériel directement 
à l’ordinateur à l’aide du câble qui convient. Cela vous permet ensuite d’importer les images 
sur la carte mémoire ou sur l’appareil via la fenêtre Importation des médias. Pour en savoir plus, 
consultez Importation à partir d’un disque dur à la page 37 et Importation à partir des caméras à 
système de fichiers à la page 22.
• Cartes mémoire : de nombreux caméscopes et matériels produisant des fichiers enregistrent 
leur média sur une carte mémoire amovible. Vous pouvez connecter un lecteur de cartes à 
votre ordinateur et l’utiliser pour transférer le contenu de votre carte mémoire à votre ordinateur. Certains ordinateurs Mac intègrent un logement pour carte SD (Secure Digital) ou SDXC 
(SD eXtended Capacity) qui leur permet de lire et d’écrire des données directement sur le support SD inséré dans ce logement. Si votre Mac est doté d’un logement de carte mémoire, vous 
pouvez retirer la carte de l’appareil photo, l’insérer dans votre Mac, puis importer les fichiers.
Pour en savoir plus, accédez au site http://support.apple.com/kb/ht3553?viewlocale=fr_FR.Chapitre 3 Importation de média 44
Vous pouvez également connecter votre dispositif à l’ordinateur à l’aide d’un câble FireWire ou 
USB. Le type de câble dont vous avez besoin varie selon le type de matériel que vous utilisez :
• Matériel USB : vous utilisez un câble USB pour les caméscopes produisant des fichiers, pour 
les appareils photo numériques qui enregistrent des vidéos, ainsi que pour l’iPhone, l’iPad et 
l’iPod touch. Le câble USB doit comporter au moins un connecteur qui se branche sur votre 
Mac (dans la partie supérieure de l’illustration ci-dessous). Il se peut que l’autre extrémité du 
câble USB, qui se branche sur votre matériel d’enregistrement, se présente différemment (dans 
la partie inférieure de l’illustration ci-dessous).
• Matériel FireWire : pour la plupart des caméscopes qui enregistrent sur bande, vous devez utiliser un câble FireWire doté d’un connecteur 6 broches à brancher sur votre Mac d’une part 
(partie supérieure de l’illustration ci-dessous) et d’un connecteur à 4 broches à brancher sur 
votre caméscope d’autre part (partie inférieure de l’illustration ci-dessous).
Il se peut que vous disposiez d’un câble FireWire 800 avec une extrémité différente qui se 
branche sur votre caméscope ou votre ordinateur.
• Matériel Thunderbolt: les dispositifs qui utilisent la technologie d’entrée/sortie Thunderbolt
présentent un connecteur qui se branche sur le port MiniDisplay de votre Mac et ressemble au 
connecteur ci-dessous.
Si aucun câble n’est fourni avec votre dispositif et si vous n’êtes pas sûr du type de matériel que 
vous possédez, vous pouvez vérifier le logo situé près des ports de câble sur votre périphérique 
pour voir s’ils correspondent aux logos USB ou FireWire ci-dessus. Dans le cas contraire, consultez 
la documentation fournie avec votre matériel.
Remarque : Tous les ordinateurs Mac ne sont pas dotés d’un port FireWire. Vérifiez la configuration de votre système pour confirmer que votre Mac prend en charge les câbles FireWire avant 
de tenter de connecter un caméscope DV ou HDV standard.
Pour vérifier si votre appareil est compatible avec Final Cut Pro, consultez la page web 
décrivant les appareils pris en charge par Final Cut Pro X à l’adresse http://help.apple.com/
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Formats de média pris en charge
Vous pouvez importer et utiliser les formats vidéo, audio et d’images fixes suivants dans 
Final Cut Pro :
Formats vidéo
• Codec Apple Animation Codec
• Codec Apple Intermediate Codec
• Apple ProRes (toutes les versions)
• AVC-Intra
• AVCHD (notamment AVCCAM, AVCHD Lite et NXCAM)
• DV (DVCAM, DVCPRO et DVCPRO50 inclus)
• DVCPRO HD
• H.264
• HDV
• iFrame
• Motion JPEG (OpenDML uniquement)
• MPEG IMX (D-10)
• REDCODE RAW (R3D)
• Sans compression 10 bits 4:2:2
• Sans compression 8 bits 4:2:2
• XAVC
• XDCAM HD/EX/HD422
• Formats QuickTime
Formats audio
• AAC
• AIFF
• BWF
• CAF
• MP3
• MP4
• WAV
 Formats d’images fixes
• BMP
• GIF
• JPEG
• PNG
• PSD (statique et avec calques)
• RAW
• TGA
• TIFFChapitre 3 Importation de média 46
Formats de conteneur
• 3GP
• AVI
• MP4
• MXF
• QuickTime
Importation et réglage de fichiers vidéo REDCODE RAW
Vous avez la possibilité d’importer et de travailler sur des fichiers REDCODE RAW (R3D) dans 
Final Cut Pro.
Les fichiers vidéo au format Raw suppose quelques étapes supplémentaires avant et après 
l’importation.
Après avoir importé les fichiers R3D RAW, vous pouvez apporter des réglages de l’étalonnage 
non destructifs directement depuis Final Cut Pro.
Importation de fichiers REDCODE RAW (R3D)
1 Installez le module approprié.
Afin que Final Cut Pro puisse reconnaître les fichiers R3D RAW, vous devez télécharger et installer 
le module correspondant. Pour en savoir plus, rendez-vous à l’adresse http://www.red.com/.
2 Importez le média.
Important : Lorsque vous importez le média, assurez-vous de désélectionner « Créer un média 
optimisé » et « Créer un média proxy », car toute tâche de transcodage réalisée durant l'importation sera mise de côté si vous ajustez les réglages RAW dans la prochaine étape.
Pour en savoir plus sur l'importation de médias, consultez Importation à partir des caméras à système de fichiers à la page 22 et Importation à partir d’un disque dur à la page 37. Pour en savoir 
plus sur le transcodage des médias, consultez la section Transcodage des fichiers de média à la 
page 415.
Remarque : Si vous importez des fichiers depuis une caméra RED ONE, il est recommandé 
d'importer uniquement les fichiers R3D RAW. Les caméras RED ONE génèrent de manière géné-
rale une série de maximum quatre fichiers de séquence de référence QuickTime (.mov) pour 
chaque fichier R3D RAW. Si vous sélectionnez le fichier R3D et les séquences de référence lors de 
la procédure d'importation, Final Cut Pro importe uniquement le fichier R3D. Si vous avez besoin 
d'importer une séquence de référence, sélectionnez uniquement la séquence, pas le fichier R3D. 
3 Adaptez les réglages RAW (à travers Final Cut Pro ou une application externe telle que 
REDCINE-X PRO).
Vous avez la possibilité d’appliquer un étalonnage non destructif sur « une lumière » à des plans 
R3D RAW, immédiatement après l’importation, pour apporter à votre métrage une apparence 
plus finie en vue de son montage et de son passage en revue. 
Si vous disposez d’un service de production professionnel avec des besoins en étalonnage 
sophistiqués, vous pouvez passer en revue ces réglages RAW lors de l’étape de finalisation. Pour 
en savoir plus, consultez « Ajustement des réglages RED RAW » ci-après.Chapitre 3 Importation de média 47
4 Vous avez la possibilité de générer du média optimisé ou proxy à partir de fichiers R3D RAW.
Pour en savoir plus, consultez « Transcodage des plans après l’importation » dans Transcodage 
des fichiers de média à la page 415.
Remarque : Dans ce cas, assurez-vous de bien configurer les préférences Final Cut Pro en consé-
quence. Pour en savoir plus, consultez Préférences de lecture à la page 438.
5 Ajoutez les plans R3D RAW à votre projet et montez-les comme vous le feriez pour tout 
autre plan.
Ajustement des réglages RED RAW
Vous pouvez ajuster les fichiers REDCODE RAW (R3D) à l'aide de la fenêtre Réglages RED RAW.
Les métadonnées relatives aux fichiers REDCODE RAW (R3D) sont stockées à deux emplacements 
particuliers:
• Réglages internes (intégrés): il s’agit des informations de métadonnées enregistrées par la 
caméra et incorporées au fichier R3D RAW. Ces réglages sont conservés avec le fichier. Ils 
peuvent être remplacés par des réglages dans le fichier .RMD externe, mais ne sont jamais 
écrasés. Vous pouvez annuler ces réglages de caméra en supprimant tout fichier RMD ou 
en sélectionnant « Réglages d'origine de la caméra » dans le menu Revenir à de la fenêtre 
Réglages RED RAW.
• Fichier RMD externe : il s’agit du fichier de métadonnées externe portant l’extension .RMD. Ce 
fichier est créé par Final Cut Pro, REDCINE-X PRO ou autre application similaire. Si vous ajustez 
les réglages RED RAW dans Final Cut Pro et qu’un fichier .RMD existe, celui-ci est remplacé 
lors de l'enregistrement des modifications. Les réglages de caméra intégrés sont conservés 
tels quels.
1 Installez le module approprié.
Afin que Final Cut Pro puisse reconnaître les fichiers R3D RAW, vous devez télécharger et installer 
le module correspondant. Pour en savoir plus, rendez-vous à l’adresse http://www.red.com/.
2 Dans le navigateur d’événements ou la timeline, sélectionnez le ou les plans que vous souhaitez régler. 
Remarque : Les plans composés ne peuvent pas être ajustés.
3 Procédez de l’une des manières suivantes:
• Choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4).
• Dans la barre d’outils, cliquez sur le bouton Inspecteur.
4 Cliquez sur le bouton d’informations dans la partie supérieure de la fenêtre qui apparaît.
5 Dans l'inspecteur d'informations, cliquez sur le bouton « Modifier les réglages RED RAW ».
Si le bouton « Modifier les réglages RED RAW » ne s'affiche pas, choisissez « Afficher l'état 
du fichier » dans le menu local Actions situé dans la partie inférieure de l'inspecteur 
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6 Ajuster les réglages dans la fenêtre Réglages RED RAW.
Vos modifications sont enregistrées sans perte dans un fichier de métadonnées externe portant 
l’extension .RMD qui remplace le précédent s'il en existe un. Contrairement aux effets vidéo qui 
s’appliquent à un plan, ces réglages sont associés au fichier (à travers le fichier de métadonnées 
.RMD). Toute modification que vous apportez à ces réglages s’applique à toutes les copies du ou 
des plans sélectionnés.
Remarque : Final Cut Pro prend en charge la carte RED ROCKET, une carte PCI qui offre des performances particulièrement accrues.
Pour en savoir plus sur les fichiers REDCODE RAW (R3D) et la carte RED ROCKET, consultez le site 
web http://www.red.com.4
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Présentation de l’analyse des données
Final Cut Pro vous offre la possibilité d’analyser vos données de média et de corriger automatiquement les problèmes courants trouvés dans vos vidéos, vos images fixes et vos fichiers audio. 
Par exemple, vous pouvez stabiliser des vidéos tremblantes, ajuster la balance des couleurs et 
supprimer des bourdonnements ou des tonalités saturées.
Vous pouvez également analyser des plans pour identifier leur contenu. L’analyse permet de 
détecter le nombre de personnes présentes dans un plan et d’identifier s’il s’agit d’un gros plan, 
d’un plan moyen ou d’un plan élargi. Cela peut être utile lorsque vous devez trouver rapidement 
un certain type de plan en visionnant du métrage ou en éditant un projet. Pour obtenir la liste 
complète des options d'analyse audio et vidéo, consultez Options d’analyse des vidéos et des 
images fixes à la page 49 et Options d’analyse audio à la page 50.
Vous pouvez analyser le média pendant ou après son importation dans Final Cut Pro. 
Final Cut Pro peut également être configuré de façon à analyser automatiquement les plans que 
vous faites glisser sur la timeline de Final Cut Pro depuis le Finder.
Après certains types d'analyse, des mots-clés sont automatiquement ajoutés aux plans ou aux 
plages de plans pour décrire les résultats de l'analyse. Par exemple, le mot-clé Tremblement 
excessif est assigné aux plages de plans contenant des vidéos tremblantes. Dans le navigateur 
d'événements, les plans possédant des mots-clés d'analyse sont indiqués avec une ligne violette 
dans la partie supérieure. (Les plans auxquels des mots-clés ont été ajoutés manuellement sont 
indiqués par une ligne bleue dans la partie supérieure. Pour en savoir plus, consultez Ajout de 
mots-clés aux plans à la page 69.)
Options d’analyse des vidéos et des images fixes
Final Cut Pro offre des options d’analyse automatique des vidéos et des images fixes pour découvrir et corriger des vidéos tremblantes, ajuster la balance des couleurs dans des vidéos ainsi que 
trouver des personnes et définir les angles de prises de vue dans les vidéos et les images fixes. 
Vous pouvez analyser les vidéos lors de leur importation ou analyser des plans vidéo dans le 
navigateur d’événements après l'importation. Les mots-clés sont automatiquement ajoutés aux 
plans ou aux plages de plans en fonction des résultats de l'analyse.
Final Cut Pro propose les options d’analyse de vidéo et d’images fixes suivantes:
• Analyser pour la stabilisation et l’obturateur roulant: analyse les plans vidéo et associent le 
mot-clé d'analyse Tremblement excessif aux plans ou aux plages de plans qui présentent un 
tremblement ou un obturateur roulant excessif, ou les deux. Si un plan comporte le mot-clé 
Tremblement excessif, ce problème peut être résolu après avoir ajouté le plan à la timeline 
en activant les corrections Stabilisation et Obturateur roulant. Consultez Correction des problèmes de tremblement excessif et d’obturateur roulant à la page 161. Si un plan ne comporte 
aucun problème de stabilisation, le mot clé Prise stabilisée lui est ajoutée.
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Remarque : Si vous effectuez une analyse pour résoudre des problèmes de stabilisation, 
il est recommandé de cocher la case « Créer des collections intelligentes après l’analyse ». 
L’activation de cette fonctionnalité vous permet de localiser facilement les plans auxquels le 
mot-clé Tremblement excessif est appliqué.
Important : L’analyse pour la stabilisation et l’obturateur roulant est disponible uniquement 
après importation. Pour en savoir plus, consultez Analyser vos données à la page 51.
• Analyser la balance des couleurs: analyse les plans vidéo pour détecter la balance des couleurs 
et le contraste. La balance des couleurs s’ajuste automatiquement lorsque vous ajoutez le 
plan à la timeline. Vous pouvez activer ou désactiver l’ajustement automatique des couleurs à 
tout moment.
• Supprimer le pulldown : analyse les plans vidéo et supprime les modèles de pulldown.
Important : Cette option est disponible uniquement pour l’importation depuis une caméra ou 
un autre appareil à bande.
• Rechercher les personnes: analyse les plans vidéo et les images fixes pour définir le nombre de 
personnes présentes et les types de plans. Une fois l’analyse effectuée, les mots-clés suivants 
sont ajoutés aux plans ou aux plages de plans: Une personne, Deux personnes, Groupe, Gros 
plan, Plan moyen ou Plan élargi.
Remarque : Si vous effectuez une analyse pour rechercher les personnes, il est recommandé 
de cocher la case « Créer des collections intelligentes après l’analyse ». L’activation de cette 
fonctionnalité vous permet de localiser facilement les plans auxquels le mot-clé Rechercher les 
personnes est appliqué.
• Consolider les résultats de recherche de personnes: consolide tous les mots-clés résultant de 
l’analyse de recherche de personnes en un seul mot-clé de type de plan et un seul mot-clé 
de personne pour chaque segment de deux minutes de la vidéo. Le mot-clé de type de prise 
est celui du type de prise le plus large et le mot-clé de personne choisi est celui représentant 
le plus grand nombre de personnes. Par exemple, si un segment vidéo contient les mots-clés 
Medium Shot, Wide Shot, One Person et Group, les mots-clés d'analyse sont réduits à Wide 
Shot et Group durant la consolidation.
• Créer des collections intelligentes après l’analyse : crée une collection intelligente pour chaque 
mot-clé appliqué lors de l’analyse de plans vidéo pour rechercher des problèmes de stabilisation ou de l’analyse de plans vidéo ou d’images fixes pour rechercher des personnes. Les 
collections intelligentes sont classées par ordre alphabétique dans un dossier de personnes à 
l'intérieur de l'événement dans la bibliothèque d'événements.
Lorsque vous faites glisser un fichier de média du Finder sur un événement Final Cut Pro ou 
sur la timeline, l’importation démarre automatiquement sans afficher de fenêtre contenant les 
options d’importation. Vous pouvez régler les options d’importation automatique dans la fenêtre 
des préférences d’importation de Final Cut Pro.
Options d’analyse audio
Final Cut Pro offre des options d'analyse automatique pour résoudre des problèmes audio 
courants, analyser et regrouper des canaux audio et supprimer les canaux muets. Vous pouvez 
analyser les données audio lors de leur importation ou analyser des plans vidéo présentant des 
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Final Cut Pro propose les options d’analyse d’audio suivantes:
• Analyser et résoudre les problèmes audio : analyse l’audio à la recherche de bourdonnement, de 
bruits et de tonalités. Final Cut Pro résout automatiquement les problèmes graves (marqués 
en rouge) et signale les problèmes moins importants (signalés en jaune). Pour en savoir plus, 
consultez Amélioration de l’audio à la page 207.
• Scinder l’audio mono et grouper l’audio stéréo : les canaux audio sont analysés et groupés en 
mono dual ou stéréo, selon les résultats de l’analyse. Les canaux audio corrigés automatiquement sont signalés comme étant sélectionnés automatiquement. Pour en savoir plus sur les 
canaux audio, consultez la section Configuration des canaux audio à la page 176.
• Supprimer les canaux silencieux : les canaux audio sont analysés et ceux laissés silencieux sont 
automatiquement supprimés. Les plans desquels des canaux sont supprimés sont signalés 
comme étant sélectionnés automatiquement. Pour en savoir plus sur les canaux audio, consultez la section Configuration des canaux audio à la page 176.
Lorsque vous faites glisser un fichier de média du Finder sur un événement ou sur la timeline 
de Final Cut Pro, l’importation démarre automatiquement sans afficher de fenêtre contenant les 
options d’importation. Vous pouvez régler les options d’importation automatique dans la fenêtre 
des préférences d’importation de Final Cut Pro.
Analyser vos données
Vous pouvez analyser les plans pendant l’importation, après l’importation dans le navigateur 
d’événements, ou configurer Final Cut Pro pour qu’il analyse automatiquement les plans lorsque 
vous les faites glisser sur un événement ou sur la timeline de Final Cut Pro.
Remarque : L’analyse pour la stabilisation et l’obturateur roulant est disponible uniquement 
après importation.
Analyse des plans lors de l’importation
1 Procédez de l’une des manières suivantes:
• Pour importer un fichier à partir d’un caméscope ou d’une caméra compatible, d’un iPad, d’un 
iPhone, d’un iPod ou de tout autre appareil : connectez l’appareil à votre ordinateur, activez-le et choisissez Fichier > Importer > Média (ou appuyez sur Commande + I). Dans la 
fenêtre qui s'affiche, sélectionnez les fichiers que vous souhaitez importer, puis cliquez sur le 
bouton Importer.
• Pour importer un fichier à partir d’un caméscope à bande : Connectez le caméscope à votre ordinateur, allumez-le et réglez-le sur le mode VTR ou VCR. Puis, sélectionnez Fichier > Importer > 
Média (ou appuyez sur Commande + I), et cliquez sur le bouton Importer.
• Pour importer un fichier à partir d’une carte mémoire : Insérez la carte mémoire dans le logement 
prévu à cet effet de votre Mac ou dans un lecteur de carte connecté à votre ordinateur et choisissez Fichier > Importer > Média (ou appuyez sur Commande + I). Dans la fenêtre qui s'affiche, 
sélectionnez les fichiers que vous souhaitez importer, puis cliquez sur le bouton Importer.
• Pour importer un fichier situé sur votre disque dur ou sur un périphérique de stockage connecté à 
votre ordinateur: Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I). Dans 
la fenêtre qui s'affiche, sélectionnez les fichiers que vous souhaitez importer, puis cliquez sur le 
bouton Importer.
• Pour importer des fichiers à partir d’une archive : Choisissez Fichier > Importer > Média (ou 
appuyez sur Commande + I). Dans la fenêtre qui s'affiche, sélectionnez ensuite une archive de 
caméra dans la liste de gauche, cliquez sur Ouvrir une archive et sélectionnez les fichiers que 
vous souhaitez importer et cliquez enfin sur le bouton Importer.Chapitre 4 Analyser les données 52
2 Dans la fenêtre qui apparaît, choisissez comment vous voulez organiser les médias importés dans 
la bibliothèque d’événements:
• Pour ajouter les médias importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez l’événement dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, « Mariage de Pierre et Sandra ») dans le champ de texte. Utilisez le menu local 
« Enregistrer dans » pour choisir le disque sur lequel vous voulez stocker l’événement.
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
3 Sélectionnez la ou les options d’analyse vidéo et audio que vous souhaitez appliquer.
Pour obtenir les descriptions des options d'analyse audio et vidéo, consultez Options d’analyse 
des vidéos et des images fixes à la page 49 et Options d’analyse audio à la page 50.
Final Cut Pro analyse alors les fichiers en arrière-plan, une fois l’importation terminée.
4 Cliquez sur Importer.
L’importation peut prendre quelques minutes, selon les options sélectionnées à l’étape 3. 
Vous pouvez voir l’état de tous les processus en cours en arrière-plan dans la fenêtre Tâches 
d’arrière-plan.
Analyse des plans après importation
1 Dans le navigateur d'événements, cliquez sur un ou plusieurs plans tout en maintenant la touche 
Contrôle enfoncée, puis choisissez « Analyser et corriger » dans le menu contextuel.
Conseil : Pour trouver rapidement un plan utilisé dans la timeline, cliquez sur le plan en maintenant la touche Contrôle enfoncée et choisissez « Afficher dans le navigateur d'événements » dans 
le menu contextuel.
2 Dans la fenêtre qui s’affiche, sélectionnez plusieurs ou toutes les options relatives à l’analyse 
vidéo et à l’analyse audio que vous souhaitez appliquer, puis cliquez sur OK.
La procédure de transcodage peut prendre un certain temps, en fonction des options d’analyse 
sélectionnées. Vous pouvez voir l’état de tous les processus en cours en arrière-plan dans la 
fenêtre Tâches d’arrière-plan.
Analyse automatique des fichiers multimédias lorsqu'ils sont déplacés vers un événement ou 
vers la timeline
1 Choisissez Final Cut Pro > Préférences.
2 Dans la fenêtre Préférences, cliquez sur Importer et sélectionnez chaque option relatives à l’analyse vidéo et à l’analyse audio que vous souhaitez appliquer.
Lorsque vous avez terminé, fermez la fenêtre Préférences.
3 Pour importer un ou plusieurs fichiers, sélectionnez un fichier (ou cliquez sur plusieurs fichiers en 
maintenant la touche Commande enfoncée) dans le Finder et faites-le glisser sur un événement 
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Afficher les mots-clés d’analyse sur les plans
Si vous analysez du média pour chercher des séquences tremblantes ou des personnes, des 
mots-clés d'analyse tels que Tremblement excessif, Une personne ou Gros plan sont ajoutés aux 
plans correspondants. Les plans ou les plages de plan avec les mots-clés d'analyse sont marqués 
d'une ligne violette dans le navigateur d'événements. 
Une ligne violette 
indique que le plan 
possède un ou 
plusieurs mots-clés 
d’analyse.
Vous pouvez afficher les mots-clés d’analyse d'un plan à plusieurs emplacements dans 
Final Cut Pro.
Affichage des mots-clés dans la fenêtre Informations du skimmer
1 Choisissez Présentation > Afficher les infos du skimmer (ou appuyez sur Contrôle +Y).
2 Survolez le plan dans le navigateur d’événements.
Les mots-clés, y compris les mots-clés d'analyse, sont affichés dans la fenêtre Informations du 
skimmer lorsque le pointeur est placé sur le plan.
Pour désactiver Informations de skimmer, choisissez Présentation > Masquer les informations de 
skimmer (ou appuyez sur Contrôle +Y).
Affichage des mots-clés en présentation par liste dans le navigateur d’événements
1 Cliquez sur le bouton Présentation par liste.Chapitre 4 Analyser les données 54
2 Pour afficher les mots-clés d’un plan, cliquez sur le triangle d’affichage en regard de celui-ci.
Les mots-clés d’analyse sont répertoriés 
en regard de la roue dentée violette.
Affichage du contenu d’une collection intelligente
Si vous choisissez de créer des collections intelligentes après l’analyse, les plans auxquels des 
mots-clés sont associés sont regroupés automatiquement en collections intelligentes au sein 
de l'événement dans la bibliothèque d'événements. Une collection intelligente est créée pour 
chaque mot-clé d'analyse et placée dans un dossier de personnes ou de stabilisation, en fonction 
du type d'analyse. 
m Dans la bibliothèque d'événements, sélectionnez une collection intelligente de mots-clés à l'inté-
rieur d'un dossier de personnes ou de stabilisation dans un événement.
Les plans contenant ce mot-clé d'analyse s’affichent dans le navigateur d’événements. Par 
exemple, si vous sélectionnez la collection intelligente Medium Shot, tous les plans de l'événement possédant ce mot-clé s'affichent dans le navigateur d'événements.
Collection intelligente Medium Shot
Ces plans incluent le mot-clé 
d’analyse Medium Shot 
(coupe moyenne).5
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Présentation des événements et des plans
Lorsque vous importez du contenu vidéo, audio ou des images fixes ou que vous les enregistrez directement dans Final Cut Pro, les fichiers de média source (votre métrage brut) s’affichent 
comme plans dans un ou plusieurs événements de la bibliothèque d’événements. Un événement correspond à un dossier qui peut contenir des dizaines, des centaines, voire des milliers 
de plans vidéo, de clips audio et d’images fixes. Chaque événement de la bibliothèque d’événements correspond à un dossier de votre disque dur qui contient les fichiers de média originaux, 
tout fichier de rendu relatif à votre média et un fichier de base de données comprenant le suivi 
de l’emplacement de l’ensemble des éléments.
Lorsque vous sélectionnez un événement dans la bibliothèque d’événements, le média qu’il 
contient s’affiche sous forme de plans dans le navigateur d’événements. Il vous suffit de sélectionner des plans ou des sections de plan dans le navigateur d’événements pour commencer à 
travailler dessus. Vous pouvez trier les plans dans le navigateur d’événements par date de création, par date d’importation, par bande, par scène, par durée de plan ou par type de fichier.
Sélectionnez un événement 
dans la bibliothèque 
d’événements.
Le navigateur d’événements 
affiche les plans dans 
l’événement sélectionné.
Lorsque vous importez du contenu vidéo dans un nouvel événement, vous devez attribuer un 
nom à ce dernier. En donnant des noms explicites à vos événements (par exemple, « Mariage des 
Dupont 2011 »), vous organisez vos données de manière à les retrouver facilement. Par défaut, 
Final Cut Pro présente les événements dans la bibliothèque d’événements en les triant selon leur 
date d’enregistrement. Vous pouvez organiser la bibliothèque d’événements différemment ou 
la masquer pour bénéficier d’un espace de travail plus étendu. La bibliothèque d’événements 
contient également les collections de mots-clés et les collections intelligentes qui vous permettent d’organiser efficacement vos projets de montage vidéo à l’aide de mots-clés et de filtres 
de recherche.
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Organisation des événements
Création d’un événement
Après l’importation de vos fichiers de média source dans Final Cut Pro, il se peut que vous ayez 
besoin de créer des événements supplémentaires pour organiser votre média. Par exemple, après 
avoir importé une prise du média pour un client donné, le cas peut se présenter où vous devez 
scinder le média en plusieurs événements en fonction de l’endroit ou du moment de la journée 
de la prise.
Création d’un événement dans la bibliothèque d’événements
1 Si la bibliothèque d’événements n’est pas affichée, cliquez sur le bouton Bibliothèque d’événements dans le coin inférieur gauche du navigateur d’événements.
2 Choisissez Fichier > Nouvel événement (ou appuyez sur Option + N).
Un nouvel événement s’affiche dans la bibliothèque d’événements
3 Saisissez un nom pour l’événement, puis appuyez sur Entrée.
4 Déplacer les plans à partir d’autres événements vers le nouvel événement, si nécessaire.
Attribution d’un nouveau nom à un événement
Modification du nom d’un événement
Au cours de l’élaboration de votre projet, il se peut que vous deviez renommer un événement 
pour mieux refléter les plans qu’il contient.
1 Dans la bibliothèque d’événements, sélectionnez l’événement dont vous souhaitez 
modifier le nom.
2 Procédez de l’une des manières suivantes:
• Cliquez sur le nom de l’événement et saisissez un nouveau nom.
• Appuyez sur Retour et saisissez un nouveau nom.
Important : La modification du nom d’un événement se répercute sur le dossier de l’événement 
situé sur le disque dur où est enregistré votre média source.
Fusion ou scission d’événements
Vous pouvez fusionner (combiner) plusieurs événements dans la bibliothèque d’événements 
(par exemple, si le média qu’ils contiennent est étroitement lié). Vous pouvez également scinder 
un événement en plusieurs si vous considérez que l’événement devient trop difficile à gérer.Chapitre 5 Organisation de votre média 57
Fusion de plusieurs événements
1 Dans la bibliothèque d’événements, procédez de l’une des manières suivantes:
• Faites glisser les événements que vous souhaitez combiner sur un nouvel événement.
• Sélectionnez les événements que vous souhaitez combiner, puis choisissez Fichier > Fusionner 
les événements.
2 Dans la fenêtre Fusionner les événements qui s’affiche, attribuez un nom à l’événement.
3 Choisissez le disque sur lequel vous souhaitez stocker les fichiers de média source de l’événement dans le menu local Emplacement, puis cliquez sur OK.
Final Cut Pro fusionne les événements sélectionnés en un seul événement dans la bibliothèque 
d’événements. Les fichiers de média source de tous les plans sont déplacés dans le dossier 
fusionné de l’événement sur le disque dur et stockés à l’emplacement défini dans le menu local.
Scission d’un événement en plusieurs
1 Créez les nouveaux événements nécessaires.
2 Déplacez les plans que vous souhaitez séparer de l’événement original vers les 
nouveaux événements.
Les fichiers de média source de tous les plans sont déplacés vers les dossiers d’événement sur le 
disque correspondant aux nouveaux événements créés dans la bibliothèque d’événements.
Important : Si vous déconnectez le disque où sont enregistrés les événements fusionnés ou 
scindés, vous ne pouvez plus accédez aux événements ou à leurs fichiers de média source depuis 
Final Cut Pro.
Copie et déplacement de plans entre les événements
Vous pouvez copier et déplacer des plans d’un événement à l’autre. Lorsque vous copiez un plan 
d’un événement à l’autre, le fichier correspondant est alors dupliqué sur le disque. Dans le cas du 
déplacement, le fichier correspondant est déplacé du dossier du premier événement à l’autre sur 
le disque.
Remarque : Lorsque vous importez des médias dans Final Cut Pro, vous avez la possibilité de 
cocher la case « Copier les fichiers dans le dossier Final Cut Events » ce qui permet de dupliquer 
les fichiers de média source sur votre disque dur. Si vous importez des fichiers alors que la case 
est décochée, Final Cut Pro crée alors des fichiers de référence (alias) pointant simplement sur 
les fichiers de média source, sans copier ces derniers. Au moment où vous copiez ou déplacez les 
plans entre des événements, Final Cut Pro copie ou déplace uniquement les fichiers de référence 
(et non les fichiers de média source). Si après avoir copié ou déplacé les plans, vous souhaitez 
remplacer les fichiers de référence correspondants par les fichiers de média source à proprement 
parler, sélectionnez les événements, puis choisissez Fichier > Organiser les fichiers d’événements. Pour plus d’informations sur les fichiers et plans, consultez Fichiers de média et plans à la 
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Copie de plans d’un événement à l’autre
1 Dans la bibliothèque d’événements, sélectionnez l’événement qui contient les plans que vous 
souhaitez copier.
2 Dans le navigateur d’événements, sélectionnez le ou les plans que vous souhaitez copier.
3 Procédez de l’une des manières suivantes:
• Si les deux événements sont situés sur le même disque dur: Faites glisser les plans en gardant la 
touche Option enfoncée d'un événement à l'autre en commençant par faire glisser l'élément, 
puis par appuyer sur la touche Option.
• Si les événements sont situés sur des disques durs différents: faites glisser les plans d’un événement à l’autre.
Déplacement de plans d’un événement à l’autre
1 Dans la bibliothèque d’événements, sélectionnez l’événement qui contient les plans que vous 
souhaitez déplacer.
2 Dans le navigateur d’événements, sélectionnez le ou les plans que vous souhaitez déplacer.
3 Procédez de l’une des manières suivantes:
• Si les deux événements sont situés sur le même disque dur: faites glisser les plans d’un événement à l’autre.
• Si les événements sont situés sur des disques durs différents: faites glisser les plans d’un événement à l’autre tout en maintenant la touche Commande enfoncée.
Il se peut que l’événement vers lequel vous avez copié ou déplacé les plans ait été réorganisé 
dans la bibliothèque d’événements. Il apparaît sous l’année durant laquelle le plan le plus récent 
qu’il contient a été enregistré.
La copie ou le déplacement d’un plan volumineux appartenant à un événement situé sur un 
disque dur vers un événement conservé sur un autre disque dur peut prendre quelques minutes 
puisque les fichiers de média source sont copiés ou déplacés d’un disque à l’autre.
Copie ou déplacement d’événements
Vous pouvez facilement copier ou déplacer un événement d’un ordinateur à un disque dur ou 
d’un disque dur à un autre. Cela peut s’avérer utile si vous souhaitez travailler sur votre événement depuis un autre ordinateur sur lequel est installé Final Cut Pro ou libérer de l’espace sur le 
disque dur de votre ordinateur.
Copie d’un événement
1 Assurez-vous qu’un disque dur externe est connecté à votre ordinateur.
2 choisissez « Regrouper les événements par disque » dans le menu local Action sous la 
bibliothèque d’événements.
L’icône et le nom du disque connecté s’affichent dans la bibliothèque d’événements.
3 Sélectionnez un événement dans le navigateur d’événements.
4 Procédez de l’une des manières suivantes:
• Choisissez Édition > Dupliquer l’événement (ou appuyez simultanément sur les touches 
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• Faites glisser l’événement sur l’icône du disque dur externe.
5 Dans la fenêtre Dupliquer l’événement, attribuez un nom au nouvel événement.
6 Pour stocker vos fichiers sur un second emplacement, définissez-le dans le menu 
local Emplacement.
7 Cliquez sur OK.
Final Cut Pro réalise une copie de l’événement à l’emplacement spécifié. Le programme effectue 
également des copies des fichiers de média source et les conserve dans un nouveau dossier 
d’événement. Souvenez-vous que la copie d’un événement contenant des fichiers de média 
source volumineux peut nécessiter plusieurs minutes.
Déplacement d’un événement
1 Assurez-vous qu’un disque dur externe est connecté à votre ordinateur.
2 choisissez « Regrouper les événements par disque » dans le menu local Action sous la 
bibliothèque d’événements.
L’icône et le nom du disque connecté s’affichent dans la bibliothèque d’événements.
3 Sélectionnez un événement dans le navigateur d’événements.
4 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Déplacer l’événement.
• Faites glisser l’événement sur l’icône du disque dur externe tout en maintenant la touche 
Commande enfoncée.
5 Pour stocker vos fichiers sur un second emplacement, définissez-le dans le menu 
local Emplacement.
6 Cliquez sur OK.
Final Cut Pro déplace l’événement à l’emplacement spécifié. Il déplace également le dossier Final Cut Events contenant les fichiers de média source. Souvenez-vous que le déplacement d’un événement contenant des fichiers de média source volumineux peut nécessiter 
plusieurs minutes.
Important : Si vous déconnectez le disque contenant l’événement déplacé, vous ne pouvez plus 
accéder à l’événement ou aux fichiers de média source dans Final Cut Pro.Chapitre 5 Organisation de votre média 60
Tri des événements
Dans la bibliothèque d’événements, vous pouvez afficher vos événements de différentes 
manières, y compris selon le disque sur lequel ils sont stockés ou leur date d’enregistrement.
Tri des événements en fonction de leur emplacement ou de leur date de stockage
m Pour afficher les événements en fonction du disque sur lequel ils sont stockés: choisissez « Regrouper 
les événements par disque » dans le menu local Action sous la bibliothèque d’événements.
m Pour afficher les événements en fonction de la date de leur enregistrement: choisissez « Grouper les 
événements par date » dans le menu local Action et choisissez une option dans le sous-menu.
Affichage des plages de date d’un événement
Final Cut Pro peut afficher les plages de dates des fichiers de média source contenus dans 
chaque événement.
m Choisissez « Afficher la plage de dates dans la bibliothèque d’événements » dans le menu local 
Action .
Tri des événements par les plus récents
m Choisissez «Disposer les événements par date décroissante » dans le menu local Action .Chapitre 5 Organisation de votre média 61
Suppression de plans ou d’événements
Vous pouvez supprimer les plans non désirés d’un événement ou supprimer la totalité d’un évé-
nement afin de libérer de l’espace sur votre disque dur. Lorsque vous supprimez un plan d’un 
événement ou la totalité d’un événement, Final Cut Pro place le média source dans la Corbeille.
Remarque : La bibliothèque d’événements doit au moins contenir un événement.
Suppression de plans d’un événement ou de la totalité d’un événement
1 Dans la bibliothèque d’événements, sélectionnez l’événement que vous souhaitez supprimer ou 
dont vous souhaitez supprimer des plans.
2 Effectuez l’une des opérations suivantes:
• Pour supprimer des plans de l’événement: sélectionnez les plans que vous souhaitez supprimer, 
puis choisissez Fichier > Placer dans la Corbeille (ou appuyez sur Commande + Supprimer).
• Pour supprimer la totalité d’un événement: choisissez Fichier > Placer l’événement dans la 
Corbeille (ou appuyez sur Commande + Supprimer).
Les fichiers de média source des plans sélectionnés ou l’événement et tous les fichiers de média 
source qui lui sont associés sont placés dans la Corbeille du Finder. Pour supprimer de façon définitive les fichiers de média source de votre disque dur, videz la Corbeille.
AVERTISSEMENT : Une fois la Corbeille vidée, il est impossible de restaurer les plans ou l’événement et leurs fichiers de média source supprimés.
Organisation des plans
Affichage et tri des plans
Vous pouvez afficher vos plans dans le navigateur d’événements de deux manières.
• Présentation en pellicule : affiche les plans de l’événement sélectionné sous forme de séries de 
vignettes. La présentation en pellicule est utile pour localiser visuellement vos plans.Chapitre 5 Organisation de votre média 62
• Présentation par liste : affiche une liste de vos plans et les informations de fichiers associées. 
Cette présentation vous permet d’afficher ou de trier vos plans en fonction de leur durée, de 
leur date de création, de leur classement, de leurs mots-clés, etc. Lorsque vous sélectionnez un 
plan dans la présentation par liste, la pellicule du plan sélectionné s’affiche en haut du navigateur d’événements. La pellicule est totalement interactive. Elle permet d’accéder aux points de 
départ et d’arrivée, aux marqueurs et aux mots-clés.
Passage de la présentation en pellicule à la présentation par liste
Procédez de l’une des manières suivantes:
m Cliquez sur le bouton Présentation en pellicule situé dans le coin inférieur gauche du navigateur 
d’événements.
m Cliquez sur le bouton Présentation par liste situé dans le coin inférieur gauche du navigateur 
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Personnalisation de la présentation en pellicule
m Pour ajuster le temps représenté par chaque vignette dans une pellicule de plan : faites glisser le curseur Durée situé dans le coin inférieur droit du navigateur d’événements.
Curseur réglé sur 5 secondes
Curseur réglé sur 30 secondes
Ajuster le curseur Durée augmente ou réduit le niveau de détail affiché dans la pellicule de 
chaque plan. Plus les vignettes représentent une longue durée, moins chaque plan comprend de 
vignettes et plus il y a de plans affichés dans le navigateur d’événements.Chapitre 5 Organisation de votre média 64
m Pour ajuster la hauteur de la pellicule : dans le coin inférieur droit du navigateur d’événements, cliquez sur le bouton Apparence du plan et ajustez le curseur Hauteur du plan.
m Pour activer et désactiver les formes d’onde audio : dans le coin inférieur droit du navigateur d’évé-
nements, cliquez sur le bouton Apparence du plan et décochez la case « Afficher les formes 
d’ondes » dans la fenêtre qui s’affiche.
Lorsque les formes d’onde audio sont activées, elles s’affichent au bas de chaque pellicule de 
plan, augmentant la hauteur de tous les plans dans le navigateur d’événements.Chapitre 5 Organisation de votre média 65
Personnalisation de la présentation par liste
m Pour choisir quel type d’information s’affiche dans les colonnes de la présentation par liste et pour 
personnaliser les colonnes: dans le navigateur d’événements, cliquez sur l’en-tête d’une colonne 
tout en maintenant la touche Contrôle enfoncée et choisissez une option de catégorie dans le 
menu contextuel.
m Pour réorganiser les colonnes dans la présentation par liste : dans le navigateur d’événements, faites 
glisser l’en-tête d’une colonne à l’emplacement de votre choix.
m Pour limiter l’affichage des plans à une catégorie dans la présentation par liste : cliquez sur l’entête d’une colonne dans le navigateur d’événements pour trier les plans d’après la catégorie 
en question.
m Pour afficher le classement et les mots-clés d’un plan dans la présentation par liste : cliquez sur le 
triangle d’affichage situé à gauche du nom du plan.
Mot-clé
Classement
Si un triangle d’affichage s’affiche à gauche d’un plan dans la présentation par liste, cela signifie 
qu’un classement, un mot-clé ou les deux ont été appliqués au plan.
Tri des plans dans le navigateur d’événements
Vous pouvez trier les plans dans le navigateur d’événements selon un ordre qui permet de mieux 
les localiser visuellement.
1 Dans la bibliothèque d’événements, sélectionnez l’événement dont vous souhaitez trier les plans.
2 Procédez de l’une des, ou des deux, manières suivantes:
• Pour grouper les plans par catégorie : choisissez « Grouper les plans par » dans le menu local 
Action (sous la bibliothèque d’événements), puis choisissez une catégorie dans le sousmenu. Choisissez l’option de tri Croissant ou Décroissant dans le même sous-menu.
• Pour définir l’option de tri des plans dans l’événement sans les grouper: choisissez «Disposer les 
plans par » dans le menu local Action (sous la bibliothèque d’événements), puis choisissez une 
catégorie dans le sous-menu.
Remarque : Il est possible de grouper des plans et de définir leur option de tri (organisation) de 
manière indépendante.
Réinitialisation de l’option de tri par défaut dans le navigateur d’événements
1 Dans la bibliothèque d’événements, sélectionnez l’événement qui contient les plans dont vous 
souhaitez réinitialiser l’option de tri.
2 Choisissez Grouper les plans par > Aucun, et Grouper les plans par > Croissant, dans le menu 
local Action sous le navigateur d’événements.
3 Choisissez Disposer les plans par > Contenu créé, et Disposer les plans par > Croissant dans le 
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Modification du nom des plans
Vous pouvez renommer à tout moment les plans dans le navigateur d’événements, l’index de la 
timeline ou l’inspecteur d’informations.
Le fait de renommer un plan n’a d’effets que sur cette instance particulière du plan. Ainsi, les 
plans que vous ajoutez à la timeline depuis le navigateur d’événements ou que vous copiez d’un 
événement à l’autre ou au sein de la timeline, constituent des instances de plan (des copies) 
indépendantes les unes des autres et qui peuvent avoir leur propre nom.
Important : La modification du nom d’un plan dans Final Cut Pro n’est pas répercutée sur le nom 
du fichier source de ce plan sur le disque.
Modification du nom d’un plan dans le navigateur d’événements
m Pour renommer un plan dans la présentation en pellicule : sélectionnez le nom d’un plan et saisissez 
un nouveau nom.
m Pour renommer un plan dans la présentation par liste : sélectionnez le nom d’un plan, appuyez sur 
Retour et saisissez un nouveau nom.
Modification du nom d’un plan dans l’index de la timeline
1 Pour ouvrir l’index de la timeline, cliquez sur le bouton Index de la timeline situé dans le coin 
inférieur gauche de la fenêtre principale de Final Cut Pro (ou appuyez sur Commande + Maj + 2).
2 Cliquez sur le bouton Plans en haut de l’index de la timeline. 
Bouton Plans
3 Cliquez sur le champ Nom d’un plan, puis saisissez un nouveau nom.
Modification du nom d’un plan dans l’inspecteur d’informations
1 Sélectionnez un plan dans le navigateur d’événements ou la timeline.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui s’affiche.
3 Dans la section Nom de l’inspecteur d’informations, cliquez sur le champ Nom, puis saisissez un 
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Classement des plans comme Favoris ou Rejetés
Si vos plans contiennent des sections dont vous n’êtes pas satisfait ou que vous ne voulez pas 
utiliser dans un projet, parce qu’ils sont flous, par exemple, vous pouvez les signaler comme 
Rejetés. Vous pouvez facilement classer les plans que dont vous êtes satisfait et ceux dont vous 
ne l’êtes pas lorsque vous les passez en revue. Lorsque vous êtes prêt à réaliser un projet ou à 
présenter un plan à un client, vous pouvez vous focaliser sur vos meilleurs métrages en affichant 
uniquement ceux marqués comme favoris. Vous pouvez également supprimer les fichiers de 
média source de vos plans rejetés pour libérer de l’espace sur votre disque dur.
Favori Rejeté
Classement des plans
1 Dans le navigateur d’événements, sélectionnez une plage, un plan ou plusieurs plans non consé-
cutifs, que vous souhaitez évaluer.
2 Procédez de l’une des manières suivantes:
• Si vous êtes satisfait de la sélection : appuyez sur la touche F ou cliquez sur le bouton Favori 
dans la barre d’outils.
Dans le navigateur d’événements, un trait vert s’affiche au-dessus des images marquées 
comme favorites.
• Si vous n’êtes pas satisfait de la sélection : appuyez sur la touche Supprimer ou cliquez sur le 
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Un trait rouge s’affiche au-dessus des images marquées comme rejetées.
Remarque : Si l’option « Masquer les projets rejetés » est activée dans le menu local Filtre dans 
la partie supérieur du navigateur d’événements, les clips rejetés ne s’affichent pas.
Suppression des classements de plans
1 Assurez-vous que les plans avec lesquels vous souhaitez travailler sont affichés dans le navigateur 
d’événements.
Il se peut que vous deviez choisir une nouvelle option, telle que Tous les plans dans le menu 
local Filtre dans le coin supérieur gauche du navigateur d’éléments pour que tous les plans auxquels vous souhaitez accéder soient visibles.
Choisissez Tous les 
plans pour recenser 
tous les plans inclus 
dans l’événement, 
indépendamment de 
leur classement.
2 Dans le navigateur d’événements, sélectionnez les plans dont vous souhaitez supprimer le classement, puis appuyez sur la touche U ou cliquez sur le bouton Effacer le classement dans la barre 
d’outils.
Les traits verts ou rouges ne s’affichent plus au-dessus des plans.
Plans dont le classement 
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Ajout de mots-clés aux plans
Vous pouvez appliquer des plans pour vous aider à localiser rapidement les plans dont vous avez 
besoin pour composer votre film. Une fois que vous avez appliqué un mot-clé à un plan ou à une 
plage de plans, le plan ou la plage en question est marqué par un trait bleu dans le navigateur 
d'événements. (Les plans comprenant des mots-clé d'analyse, qui sont appliqués automatiquement après certains types d'analyse, sont marqués d'une ligne violette. Pour en savoir plus, 
consultez Présentation de l’analyse des données à la page 49.)
De plus, lorsqu’un mot-clé est appliqué à un plan ou à une plage de plans, une collection de 
mots-clés s’affiche dans la bibliothèque d’événements. Une collection de mots-clés contient des 
pointeurs (alias) renvoyant vers des plans marqués par un mot-clé spécifique. Par exemple, si 
vous appliquez le mot-clé « Nicholas » à tous les plans contenant Nicholas, vous pouvez sélectionner la collection de mots-clés « Nicholas » dans la bibliothèque d’événements pour afficher 
tous les plans contenant ce mot-clé dans le navigateur d’événements. 
Une ligne bleue indique que le 
Collections de mots-clés plan possède des mots-clés.
Vous pouvez appliquer un ou plusieurs mots-clés à une plage d’un plan, à un plan entier ou à un 
groupe de plans dans un événement.
Application de mots-clés à l’aide de l’éditeur de mots-clés
1 Dans le navigateur d’événements, sélectionnez une plage, un plan précis ou plusieurs plans non 
contigus auxquels vous souhaitez appliquer des mots-clés.
2 Pour ouvrir l’éditeur de mots-clés, cliquez sur le bouton Mots-clés dans la barre d’outils.
3 Au sommet de l’éditeur de mots-clés, saisissez le ou les mots-clés que vous souhaitez appliquer à 
la sélection, puis appuyez sur Retour.
Saisissez un mot-clé ou 
une phrase de mots-clé, 
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4 Répétez l’étape 3 pour chaque mot-clé que vous souhaitez ajouter à la sélection.
Une ligne bleue s’affiche en haut de la sélection dans le navigateur d’événements, indiquant que 
les mots-clés lui ont été appliqués.
5 Lorsque vous avez terminé l’ajout de mots-clés, fermez l’éditeur de mots-clés.
Ajout de mots-clés à l’aide de raccourcis clavier
Pour ajouter des mots-clés à vos plans à l’aide de raccourcis clavier, vous devez préalablement 
assigner des mots-clés aux raccourcis clavier.
1 Si l’éditeur de mots-clés n’est pas ouvert, cliquez sur le bouton Mots-clés dans la barre d’outils.
2 Dans l’éditeur de mots-clés, cliquez sur le triangle d’affichage à gauche de Raccourcis clavier.
3 Saisissez un mot-clé ou une phrase dans chaque champ, puis appuyez sur Retour.
Pour réassigner un raccourci clavier, sélectionnez le champ lui correspondant et saisissez un nouveau mot-clé.
Saisissez à cet 
emplacement 
les mots-clés ou 
l’expression-clé 
à affecter aux 
raccourcis clavier.
4 Pour utiliser un raccourci clavier, sélectionnez une plage ou un ou plusieurs plans non contigus 
auxquels vous souhaitez ajouter des mots-clés, puis appuyez simultanément sur Contrôle et sur 
la touche numérotée correspondante (1 à 9).
Affichage des mots-clé appliqués aux plans
m Pour identifier rapidement des plans qui possèdent des mots-clé : sélectionnez un événement dans 
le navigateur d’événements. 
Les plans qui possèdent un ou plusieurs mots-clé s'affichent dans le navigateur d'événements 
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m Pour afficher tous les mots-clés appliqués à un plan : choisir Présentation > Afficher les infos du 
skimmer (ou appuyer sur Contrôle +Y) et survoler le plan dans le navigateur d'événements. 
Vous pouvez aussi afficher les mots-clés en sélectionnant le plan dans le navigateur d'événements et en cliquant sur le bouton Mots-clés dans la barre d'outils. Les mots-clés appliqués au 
plan sont affichés dans l'éditeur de mots-clés.
m Pour afficher tous les plans qui possèdent un mot-clé spécifique : Sélectionner une collection de 
mots-clés dans la bibliothèque d’événements. 
Les plans contenant ce mot-clé s’affichent dans le navigateur d’événements.
Suppression de tous les mots-clés d’une sélection
1 Dans le navigateur d’événements, sélectionnez une plage, un plan précis ou plusieurs plans non 
contigus desquels vous souhaitez supprimer des mots-clés.
Une ligne bleue tracée en haut des plans indique les sections des plans auxquelles sont appliqués des mots-clés.
2 Choisissez Marquer > Supprimer tous les mots-clés (ou appuyez sur Contrôle + 0).
Suppression d’un sous-ensemble de mots-clés d’une sélection
1 Dans le navigateur d’événements, sélectionnez une plage, un plan précis ou plusieurs plans non 
contigus desquels vous souhaitez supprimer des mots-clés.
Une ligne bleue tracée en haut des plans indique les sections des plans auxquelles sont appliqués des mots-clés. Chaque mot-clé assigné à un plan est également repris dans la présentation 
par liste.
2 Cliquez sur le bouton Mots-clés dans la barre d’outils pour ouvrir l’éditeur de mots-clés, sélectionnez le ou les mots-clés que vous souhaitez supprimer et appuyez sur Supprimer.
Sélectionnez le ou les 
mots-clés à supprimer 
de la sélection, puis 
appuyez sur suppr.Chapitre 5 Organisation de votre média 72
Ajout ou modification de notes de plan
Lorsque vous réexaminez vos plans, vous pouvez ajouter et modifier des notes à leur sujet dans 
le navigateur d’événements ou l’index de la timeline. Vous pouvez retrouver rapidement vos 
plans en saisissant le texte des notes dans le champ de recherche du navigateur d’événements 
ou de l’index de la timeline, ou dans le champ de texte de la fenêtre Filtre.
Remarque : Vous pouvez ajouter des notes à chaque instance d’un plan. Ainsi, les plans que vous 
ajoutez à la timeline depuis le navigateur d’événements ou que vous copiez d’un événement à 
l’autre ou au sein de la timeline, constituent des instances de plan (des copies) indépendantes les 
unes des autres.
Ajout ou modification de notes de plan dans le navigateur d’événements
1 Cliquez sur le bouton Présentation par liste situé dans le coin inférieur gauche du navigateur 
d’événements.
2 Sélectionnez le plan auquel vous voulez ajouter des notes ou dont vous voulez modifier 
les notes.
Remarque : Les notes s’appliquent à un plan intégral et non à des plages de sélection.
3 Cliquez sur le champ Notes du plan, puis saisissez vos remarques ou modifiez-les.
Ajout ou modification de notes de plan dans l’index de la timeline
1 Pour ouvrir l’index de la timeline, cliquez sur le bouton Index de la timeline situé dans le coin 
inférieur gauche de la fenêtre principale de Final Cut Pro (ou appuyez sur Commande + Maj + 2).
2 Pour ouvrir la fenêtre Plans, cliquez sur le bouton Plans en haut de l’index de la timeline. 
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3 Si la colonne Notes n’est pas visible dans la fenêtre Plans, cliquez sur l’en-tête d’une colonne en 
maintenant la touche Contrôle enfoncée et choisissez Notes dans le menu contextuel.
4 Cliquez sur le champ Notes du plan, puis saisissez vos remarques ou modifiez-les.
Saisir ici les notes 
pour un plan.
Organisation des plans en fonction des rôles
Il est possible d’organiser les plans en fonction de rôles (étiquettes de métadonnées affectées 
aux plans). 
Lorsque vous importez des plans (vidéo, audio ou images fixes), Final Cut Pro attribue automatiquement l’un des cinq rôles par défaut aux composants vidéo et audio de chaque plan : Vidéo, 
Titres, Dialogue, Musique et Effets. Vous pouvez aussi créer des rôles et des sous-rôles personnalisés et les attribuer à vos plans.
Vous pouvez visualiser et réaffecter des rôles dans l’index de la timeline, le navigateur d’événements ou l’inspecteur d’informations. Vous pouvez par exemple identifier facilement tous vos 
plans de dialogue et les lire isolément par rapport aux autres plans audio. Consultez Affichage et 
réattribution de rôles à la page 311.
Recherche de plans dans le navigateur d’événements
Dans Final Cut Pro, il vous est possible de rechercher du média de deux manières. 
• Filtrer rapidement les plans par marquage : utilisez le menu local Filtre dans le navigateur d’évé-
nements pour localiser rapidement des plans en fonction de leur classement, de l’absence de 
classement ou de mots-clés.
• Rechercher d’après une combinaison de critères à l’aide de la fenêtre Filtre : utilisez la fenêtre Filtre 
pour effectuer des recherches complexes de plans, aussi appelées recherches pondérées. Vous 
pouvez utiliser une large gamme de critères de recherche, notamment par le nom du plan, 
le classement, le type de média, le tremblement excessif, des mots-clés, la présence de personnes, des informations relatives au format et la date.
Filtrage rapide des plans par classement
Utilisez le menu local Filtre dans le navigateur d’événements pour trouver rapidement des plans 
en fonction de leur classement.
1 Dans la bibliothèque d’événements, sélectionnez un ou plusieurs événements que vous 
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2 Choisissez une option dans le menu local Filtre au sommet du navigateur d’événements.
• Tous les plans: affiche tous les plans de l’événement.
• Masquer les projets rejetés: affiche tous les plans ou toutes les plages, excepté ceux marqués 
comme rejetés.
• Aucun classement ou mot-clé : affiche uniquement les plans ou les plages sans classement 
ou mot-clé.
• Favoris: affiche uniquement les plans ou les plages classés comme favoris.
• Rejetés: affiche uniquement les plans ou les plages classés comme rejetés.
Recherche des plans selon une combinaison de critères
La fenêtre Filtre vous permet de combiner plusieurs critères de recherche. Par exemple, vous 
pouvez rechercher des plans vidéo contenant le texte « extérieur » dans leurs métadonnées.
1 Dans la bibliothèque d’événements, sélectionnez l’événement ou le dossier dans lequel vous 
souhaitez effectuer votre recherche.
2 Cliquez sur le bouton Filtre situé au sommet du navigateur d’événements.
3 Dans la fenêtre Filtre, choisissez vos critères de recherches ou règles, dans le menu local Ajouter 
une règle.
Menu local Ajouter 
une règle
• Texte : recherchez des plans par leur nom ou les notes les concernant dans la présentation par 
liste à l’aide de texte. Vous pouvez ajouter plusieurs règles textuelles pour rechercher plus d’un 
mot ou d’une phrase ou pour éliminer des mots ou des phrases spécifiques de la recherche.
• Classements: recherchez des plans en fonction de leur classement (favori ou rejeté).
• Type de média : recherchez des plans dont les fichiers de média source sont d’un type particulier, tel que vidéo, audio ou fixe.
• Stabilisation : recherchez des plans vidéo identifiés par Final Cut Pro comme présentant un 
tremblement excessif.
• Mots-clés: recherchez des plans en fonction des mots-clés leur étant assignés. Vous pouvez 
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• Personnes: recherchez des plans identifiés par Final Cut Pro comme contenant des personnes.
• Infos sur le format recherchez des plans en fonction des informations sur leur format, telles que 
la fréquence d’image vidéo ou le numéro de la scène.
• Date : recherchez des plans en fonction de la date de création du fichier de média ou de la 
date d’importation du média dans Final Cut Pro.
• Rôles: recherchez des plans en fonction des rôles qui leur ont été attribués.
Pour supprimer une règle, cliquez sur le bouton Supprimer situé à droite de la règle. Pour 
exclure une règle de la recherche sans la supprimer, il suffit de décocher la case située à gauche 
de celle-ci.
4 Effectuez une recherche plus précise en choisissant des éléments des menus locaux pour les 
règles ajoutées.
5 Procédez de l’une des manières suivantes:
• Pour spécifier qu’un plan doit correspondre à au moins un des critères ou des mots-clés: choisissez 
N’importe quel(le) dans le menu local situé dans le coin supérieur gauche de la fenêtre Filtre.
• Pour spécifier qu’un plan doit correspondre à tous les critères et mots-clés: Choisissez Tous dans le 
menu local.
Les plans qui correspondent aux critères de recherche s’affichent dans le navigateur d’événements et les icônes indiquant l’état de recherche s’affichent à droite du bouton Filtre au sommet 
du navigateur d’événements.
Si vous le souhaitez, vous pouvez enregistrer les résultats de votre recherche sous forme de 
collection intelligente qui regroupe automatiquement les plans en fonction de vos critères 
de recherche.
Effacement d’une recherche pondérée
m Cliquez sur le bouton Réinitialiser situé à droite des icônes d’état de recherche dans le coin supé-
rieur droit du navigateur d’événements.
Conseil : Si les plans ne s’affichent toujours pas, assurez-vous de choisir l’option « Tous les plans » 
ou « Masquer les projets refusés » dans le menu local Filtre situé dans le coin supérieur gauche 
du navigateur d’événements.
Recherche de plans par nom et par notes
Vous pouvez utiliser le champ de recherche pour trouver rapidement des plans par nom ou par 
notes (en mode de présentation par liste) sans devoir ouvrir la fenêtre Filtre.
1 Dans la bibliothèque d’événements, sélectionnez un ou plusieurs événements que vous 
souhaitez rechercher.
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Conduite d’un flux de production de filtrage et de recherche
L’exécution d’une recherche pondérée suivie d’un filtrage des plans dans le navigateur d’événements en fonction du classement est un moyen efficace de trouver rapidement des plans. Il s’agit 
aussi de la meilleure méthode pour trouver des plans spécifiques n’ayant pas été évalués et les comparer à ceux l’ayant été.
1 Dans la bibliothèque d’événements, sélectionnez l’événement ou le dossier dans lequel vous souhaitez effectuer votre recherche.
2 Recherchez des plans à l’aide d’une combinaison de critères de recherche tel que décrit précédemment dans la section « Recherche des plans selon une combinaison de critères ». Toutefois, veillez à 
ne pas appliquer de filtre de classement dans la fenêtre Filtre.
3 Utilisez le menu local Filtre, tel que décrit précédemment dans la section « Filtrage rapide des plans 
par classement », pour filtrer rapidement les plans en fonction de leur classement.
4 Répétez l’étape 3 jusqu’à trouver les plans que vous recherchez.
Enregistrement des recherches sous forme de collections intelligentes
Lorsque vous recherchez des plans dans un événement à l’aide de la fenêtre Filtre, vous pouvez 
enregistrer vos résultats en créant une collection intelligente qui regroupe les plans correspondant 
aux critères de recherche. Chaque fois qu’un nouveau plan qui satisfait les critères de recherche de la 
collection intelligente est ajouté à l’événement, il est automatiquement ajouté à celle-ci.
Les plans qui s’affichent dans les collections intelligentes ne sont pas dupliqués. Les collections intelligentes filtrent des plans dans un événement pour vous aider à vous centrer sur les plans dont vous 
avez besoin pour une tâche spécifique.
Création d’une collection intelligente se reposant sur des critères de recherche
1 Dans la bibliothèque d’événements, sélectionnez un événement.
2 Utilisez la fenêtre Filtre pour rechercher des plans en fonction des critères de recherche indiqués.
3 Dans la fenêtre Filtre, cliquez sur le bouton Nouvelle collection intelligente.
Une nouvelle collection intelligente sans titre s’affiche dans la bibliothèque d’événements.
4 Saisissez un nom pour la collection intelligente et appuyez sur Retour.
Lorsque vous ajoutez à l’événement des plans qui satisfont les critères de recherche de la collection 
intelligente, ils sont automatiquement ajoutés à celle-ci.
Modification du contenu d’une collection intelligente
1 Dans la bibliothèque d’événements, double-cliquez sur la collection intelligente dont vous souhaitez 
modifier le contenu.
La fenêtre Filtre de la collection intelligente s’affiche.
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2 Modifiez les critères de recherche dans la fenêtre Filtre.
3 Lorsque vous avez terminé, fermez la fenêtre.
Remarque : Si vous modifiez le classement ou les mots-clés d’un plan de telle manière qu’il ne 
satisfait plus les critères de recherche de la collection intelligente, le plan ne s’affiche plus dans 
cette collection.
Suppression d’une collection intelligente
m Dans la bibliothèque d’événements, sélectionnez la collection intelligente que vous souhaitez éliminer, puis choisissez Fichier > Supprimer la collection intelligente (ou appuyez sur 
Commande + Supprimer).
La collection intelligente est supprimée de la bibliothèque d’événements, mais les plans qui lui 
sont associés (qui apparaissent dans celle-ci) ne sont pas affectés.
Organisation des mots-clés et des collections intelligentes
Vous pouvez organiser les collections de mots-clés et les collections intelligentes dans la bibliothèque d’événements sous forme de dossiers.
Organisation des collections à l’aide de dossiers
1 Dans la bibliothèque d’événements, sélectionnez l’événement contenant les collections que vous 
souhaitez organiser, puis choisissez Fichier > Nouveau dossier.
2 Saisissez un nom pour le nouveau dossier qui s’affiche dans l’événement.
3 Sélectionnez les collections intelligentes et les collections de mots-clés que vous souhaitez organiser et faites-les glisser dans le nouveau dossier.
Vous pouvez afficher et masquer le contenu du dossier en cliquant sur le triangle d’affichage 
situé à gauche du nom du dossier.6
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Présentation de la lecture et du survol
Final Cut Pro simplifie le visionnage et l’écoute de média, que celui-ci se situe dans le navigateur 
d’événements, dans la bibliothèque de projets ou dans la timeline. Ses fonctionnalités de preview 
dynamiques vous permettent retrouver rapidement ce que vous recherchez sans perdre de vue la 
tâche que vous devez réaliser.
Deux outils sont à votre disposition pour effectuer un preview et reproduire du média dans 
Final Cut Pro :
• La tête de lecture marque le point actif sur la timeline ou dans le navigateur d’événements. Vous 
pouvez à loisir déplacer la tête de lecture en la faisant glisser ou en cliquant sur une autre zone 
de la timeline ou du navigateur d’événements. Elle vous permet en outre de faire défiler ou de 
reproduire la vidéo à partir de son point actif.
La tête de lecture se présente sous la forme d’un trait vertical gris fixe à moins que vous ne la 
déplaciez ailleurs ou cliquiez sur un autre point.
• Le skimmer, d’autre part, vous permet de prévisualiser les plans sur la timeline, dans le navigateur d’événements ou dans la bibliothèque de projets, sans affecter pour autant la position de la 
tête de lecture. Utilisez le skimmer pour survoler le contenu ou parcourir à loisir les plans pour 
effectuer la lecture depuis l’emplacement du pointeur en fonction de sa vitesse de déplacement.
Le skimmer se présente sous la forme d’un trait vertical rose au fur et à mesure que vous déplacez le pointeur sur la zone en cours de survol. Si vous avez activé la fonction de magnétisme, le 
skimmer devient alors orange lorsqu’il s’aligne sur un point précis.
Tête de lecture Tête de lecture
Skimmer
Skimmer
Lorsque la fonction de survol est activée, vous avez la possibilité de parcourir les données multimédias pour visualiser le contenu d’autres plans tout en conservant l’emplacement de la tête de 
lecture sur la timeline. Si cette dernière, ainsi que le skimmer, sont présents sur le même plan, le 
skimmer prend la priorité et devient l’emplacement par défaut de lecture ou de montage.
Si le survol est désactivé ou que le skimmer est absent sur un plan, la tête de lecture constitue 
alors l’emplacement par défaut.
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Lecture du média
Vous avez la possibilité de reproduire des projets et des plans dans Final Cut Pro. Les options de 
lecture comprennent la lecture depuis le début, à partir d’un certain point, en boucle et à diffé-
rentes vitesses. Vous avez également la possibilité d’effectuer la lecture en plein écran. 
Le réglage de lecture sélectionné dans les préférences Montage de Final Cut Pro définit si 
Final Cut Pro utilise un média proxy, votre média original ou un média optimisé lors de la lecture. 
Consultez Préférences de lecture à la page 438 pour en savoir plus.
Lecture de plans vidéo et de clips audio
m Pour lire un projet ou un plan depuis le début: sélectionnez le projet ou le plan, puis choisissez 
Présentation > Lecture > Lire depuis le début (ou appuyez sur Maj + Contrôle + I).
m Pour lire une section d’un projet, des plans sélectionnés ou une plage d’images depuis le début: 
sélectionnez le projet, les plans, l’intégralité ou une partie d’un même plan, puis choisissez 
Présentation > Lecture > Lire la sélection, ou appuyez sur Barre oblique (/).
Si vous sélectionnez un plan entier, une partie d’un plan ou le projet complet, la zone sélectionnée s’encadre en jaune.
Cadre jaune
m Pour lire un projet ou un plan à partir d’un point précis: dans le navigateur d’événements ou la 
timeline, cliquez sur un point dans un projet ou dans un plan à l’endroit où vous voulez commencer (ou placez la tête de lecture sur le point voulu dans la timeline) et appuyez sur la barre 
d’espace ou cliquez sur le bouton de lecture dans le visualiseur (ou appuyez sur la touche L).
La lecture du plan ou 
du projet commence au 
niveau du skimmer ou de 
la tête de lecture.
m Pour lire dans la zone de la tête de lecture ou du Skimmer: choisissez Présentation > Lecture > Lire 
le contexte, ou appuyez sur Maj + point d’interrogation (?).
Skimmer
m Pour interrompre la lecture : appuyez sur la barre d’espace.Chapitre 6 Lecture et survol du média 80
Usage des touches J, K et L pour la lecture
Les touches J, K et L de votre clavier vous permettent de lire un projet ou un plan. La lecture 
se lance depuis la tête de lecture (dans le cas d’un projet) ou depuis le skimmer (dans le cas 
d’un plan). Vous pouvez aussi passer par les touchesJ, K et L pour contrôler un dispositif de 
lecture vidéo.
Fait défiler les 
vitesses de lecture 
vers l’avant
Fait défiler les 
vitesses de lecture 
vers l’arrière
Pause
Ces touches vous permettent d’accélérer la lecture jusqu’à 32 fois (32x).
m Pour lancer la lecture normale (vitesse 1x): appuyez sur L.
m Pour lancer la lecture inverse (vitesse 1x): appuyez surJ.
m Pour mettre la lecture en pause : appuyez sur K.
m Pour doubler la vitesse de lecture : appuyez sur L ou surJ deux fois.
m Pour inverser immédiatement le sens de lecture : appuyez surJ pour lire dans le sens inverse, ou 
sur L pour lire dans le sens normal.
m Pour faire avancer ou reculer la tête de lecture d’une image à la fois: maintenez la touche K enfoncée, et appuyez surJ ou sur L.
m Pour déplacer la tête de lecture à vitesse réduite de moitié (1/2x): maintenez la touche K enfoncée 
tout en appuyant sur la touche J ou L.
Si vous faites appel aux raccourcis clavier pour contrôler un appareil (comme un caméscope 
ou une caméra), la vitesse de lecture avant (L) et inverse (J) peut différer en fonction de votre 
équipement vidéo.
Lecture en boucle du média
Il est possible d’activer la mise en boucle de sorte qu’un projet (ou une partie de projet) se lise 
continuellement en boucle.
1 Pour activer la lecture en boucle, effectuez l’une des opérations suivantes:
• Choisissez Présentation > Lecture > Lecture en boucle (ou appuyez sur Commande + L).
• Cliquez sur le bouton Lecture en boucle.
2 Procédez de l’une des manières suivantes:
• Pour mettre tout le projet en boucle : appuyez sur la barre d’espace.
• Pour mettre une partie d’un projet en boucle : sélectionnez une plage ou un plan dans la timeline, puis choisissez Présentation > Lecture > Sélection, ou appuyez sur la touche de la barre 
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Lecture de vidéo en présentation Plein écran
1 Sélectionnez ou ouvrez un projet dans la bibliothèque de projets ou ouvrez un plan dans le 
navigateur d’événements et positionnez la tête de lecture à l’endroit où vous voulez que la 
vidéo commence.
2 Procédez de l’une des manières suivantes:
• Choisissez Présentation > Lecture > Lire en plein écran (ou appuyez sur Commande + Maj + F).
• Cliquez sur le bouton « Lire en plein écran » situé sous le visualiseur.
L’élément se lit en présentation Plein écran à partir du point où se trouve la tête de lecture.
3 Pour quitter la présentation Plein écran, appuyez sur la touche Échap.
Lorsque vous reproduisez des plans, les images au niveau de la tête de lecture ou du skimmer 
sont lues dans le visualiseur. Si vous devez comparer deux plans simultanément, vous pouvez 
passer par le visualiseur d’événements, un visualiseur à part permettant la lecture exclusive 
de plans d’événement. Le visualiseur d’événements s’affiche à gauche du visualiseur principal. 
Pour en savoir plus, consultez Lecture et survol du média dans le visualiseur d’événements à la 
page 83.
Survol du média
Il vous est possible de survoler rapidement votre vidéo et votre audio pour en effectuer un preview, rechercher un plan particulier ou réaliser un montage. Lorsque le survol est activé et que 
vous déplacez le pointeur sur un plan situé dans le navigateur d’événements ou sur la timeline, 
le contenu sous le pointeur se lit alors dans le visualiseur.
Vous pouvez aussi passer par les outils de montage Lame de rasoir, Trim et Sélection de plage 
pour survoler les plans sur la timeline ou dans l’éditeur de précision.
Au fur et à mesure que vous effectuez le montage dans Final Cut Pro, il se peut que le survol ait 
tendance à vous distraire lorsque vous déplacez le pointeur d’un point à un autre. Vous pouvez 
dans ce cas désactiver complètement la fonction du survol (ou vous limiter à rendre inopérant le 
survol audio).
Survol de plans
m Dans le navigateur d’événements ou la timeline, déplacez le pointeur sur un plan.
Le skimmer (représenté par un trait vertical rose) indique exactement où se trouve le point actif 
au fur et à mesure que vous survolez le média ; les images correspondantes s’affichent en outre 
dans le visualiseur.
Skimmer
Conseil : Vous pouvez aussi appuyer à tout moment sur la barre d’espace pour lire depuis l’emplacement du skimmer.Chapitre 6 Lecture et survol du média 82
Survol de plans à l’aide des outils de montage
Vous avez la possibilité de survoler les plans tout en utilisant les outils Lame de rasoir, Trim et 
Sélection de plage sur la timeline ou dans l’éditeur de précision. Ceux-ci se comportent comme 
des skimmers au fur et à mesure que vous placez le pointeur sur un plan.
1 Sélectionnez un plan sur la timeline ou ouvrez l’éditeur de précision.
2 Choisissez Lame de rasoir, Trim ou Sélection de plage dans le menu local Outils situé sur la barre 
d’outils.
3 Déplacez l’outil en avant ou en arrière sur un plan.
Lorsque vous utilisez un outil de montage faisant office de skimmer, il vous est possible de survoler et d’ajouter des marqueurs à des plans sous les plans connectés dans la timeline.
Activation et désactivation de la fonction de survol
m Pour activer et désactiver le survol : cliquez sur le bouton Survol, choisissez Présentation > Survol, 
ou appuyez sur S.
m Pour activer et désactiver le survol audio : cliquez sur le bouton « Audio lors du survol », choisissez 
Présentation > Audio lors du survol, ou appuyez sur Maj + S.
Une fois la fonction activée, les boutons de survol apparaissent en bleu.
La fonction de survol audio 
est désactivée.
La fonction de survol est activée.
Remarque : Lorsque le survol est désactivé, vous avez néanmoins la possibilité de survoler à 
l’aide des outils de montage Lame de rasoir, Trim et Sélection de plage. 
Survol d’audio pour des plans ou des composants audio précis
Vous pouvez configurer le survol de plan pour limiter la fonction à un plan particulier. Cela 
s’avère utile si vous disposez d’un plan connecté dans la timeline et souhaitez en effectuer le 
survol sans avoir à écouter l’audio du plan dans le scénario principal.
Important : Le survol audio doit également être activé afin de pouvoir utiliser 
cette fonctionnalité.
Vous pouvez aussi faire appel au survol de plan pour écouter également un composant audio 
particulier lors du montage des plans présentant des composants audio développés. Si le survol 
de plan est éteint, vous pouvez alors entendre l’audio combiné de tous les composants intégrant 
le plan au fur et à mesure que vous effectuez le survol.Chapitre 6 Lecture et survol du média 83
Conseil : Pour afficher les composants audio sous leur forme développée, sélectionnez le plan 
dans la timeline, puis choisissez Plan > Développer les composants audio (ou appuyez sur 
Option + Contrôle + S).
m Pour activer ou désactiver le survol, choisissez Présentation >Survol du plan (ou appuyez sur 
Commande + Option + S).
Lecture et survol du média dans le visualiseur d’événements
Il se peut que vous ayez parfois besoin de deux visualiseurs afin de pouvoir lire et survoler les 
plans d’événements de façon isolée des plans dans la timeline. Le visualiseur d’événements 
représente un affichage vidéo distinct qui apparaît en regard du visualiseur principal. En ouvrant 
le visualiseur d’événements et le visualiseur, vous pouvez ainsi afficher deux plans simultané-
ment : l’un dans le navigateur d’événements et l’autre dans la timeline.
Visualiseur d’événements Visualiseur
Vous ne pouvez utiliser le visualiseur d’événements pour lire des plans que dans le navigateur 
d’événements. Comme pour le visualiseur principal, vous pouvez afficher les instruments vidéo, 
les canaux de couleurs, les zones sécurisées des titres et de l’action, ainsi que les angles multicam 
(avec le visualiseur d’événements configuré de façon à afficher les angles). Les commandes de 
lecture et d’ajustement sont identiques dans le visualiseur et dans le visualiseur d’événements. 
Les autres opérations en relation avec le visualiseur (notamment les commandes à l’écran et les 
effets intégrés) se font à travers le visualiseur principal.
L’interface du double visualiseur s’inspire des systèmes à bande linéaires qui incluaient des moniteurs pour la source et pour l’enregistrement. Le moniteur source servait à la prévisualisation des 
plans source et aux sélections dans les plans en question. Le moniteur d’enregistrement permettait la reproduction du programme une fois monté.
Ouvrir le visualiseur d’événements
m Choisissez Fenêtre > Afficher le visualiseur d’événements (ou appuyez sur 
Commande + Contrôle + 3).
Pour fermer le visualiseur d’événements, choisissez Fenêtre > Masquer le visualiseur d’événements (ou appuyez sur Commande + Contrôle + 3).
Remarque : Si vous utilisez des instruments vidéo avec le visualiseur d’événements, il peut 
s’avérer pratique d’afficher les instruments sous l’image vidéo plutôt que sur le côté gauche (par 
défaut). Pour afficher les instruments repris sous l’image vidéo, choisissez Présenter verticalement dans le menu local Réglages du visualiseur d’événements. Pour en savoir plus, consultez 
Utilisation des instruments vidéo à la page 387.Chapitre 6 Lecture et survol du média 84
Lecture sur un deuxième écran
Si vous possédez un deuxième écran branché sur votre ordinateur, vous pouvez y afficher le 
visualiseur afin de lire la vidéo, ou le navigateur d’événements pour consulter les plans d’un évé-
nement, étendant ainsi votre espace de travail dans la fenêtre Final Cut Pro.
Affichage du visualiseur sur un second moniteur
1 Branchez un deuxième écran (moniteur informatique branché sur la carte graphique PCI) et 
assurez-vous qu’il est relié au secteur et allumé.
2 Dans Final Cut Pro, choisissez Fenêtre > Afficher les visualiseurs sur le second moniteur.
Le visualiseur apparaît alors sur le deuxième écran. Toutes les fonctionnalités du visualiseur 
(notamment les commandes à l’écran) sont dès lors disponibles sur le deuxième écran.
Remarque : Si le visualiseur d’événements est également visible, les deux visualiseurs s’affichent 
alors sur le deuxième écran.
3 Pour renvoyer le visualiseur sur la fenêtre principale de Final Cut Pro, choisissez Fenêtre > Afficher 
les visualiseurs dans la fenêtre principale.
Affichage de la bibliothèque et du navigateur d’événements sur un second moniteur
1 Branchez un deuxième écran (moniteur informatique branché sur la carte graphique PCI) et 
assurez-vous qu’il est relié au secteur et allumé.
2 Dans Final Cut Pro, choisissez Fenêtre > Afficher les événements sur le second moniteur.
La bibliothèque et le navigateur d’événements apparaissent sur le deuxième écran. Toutes les 
fonctionnalités propres aux événements (notamment la sélection, les marqueurs, les mots-clés, 
etc.) sont dès lors disponibles sur le deuxième écran.
Pour renvoyer la bibliothèque d’événements et le navigateur d’événements sur la fenêtre principale de Final Cut Pro, choisissez Fenêtre > Afficher les événements dans la fenêtre principale.Chapitre 6 Lecture et survol du média 85
Lecture sur un moniteur externe
Final Cut Pro propose l’option de sortie A/V pour envoyer la vidéo et l’audio de votre ordinateur 
à un moniteur externe. En plus de pouvoir vérifier à quoi la vidéo et l’audio ressemblent sur un 
moniteur broadcast NTSC/PAL ou HD, cette fonctionnalité vous permet également de tester la 
sortie sur des dispositifs plus sophistiqués, tels que des vecteurscopes et des oscilloscopes.
La sortie A/V n’est disponible que sous OS X Lion 10.7.2 ou ultérieur et nécessite une interface 
vidéo matérielle et logicielle de tierce partie compatible. Les appareils DV FireWire ne sont pas 
pris en charge. Pour en savoir plus, contactez le fabricant de l’équipement ou accédez à la page 
web des ressources Final Cut Pro X à l’adresse http://www.apple.com/fr/finalcutpro/resources.
Lecture vidéo et audio sur un moniteur externe
1 Installez les matériel et logiciel d’interfaçage vidéo en suivant les instructions du fabricant.
2 Branchez un moniteur externe sur l’interface vidéo et assurez-vous qu’il est relié au secteur 
et allumé.
3 Pour sélectionner un équipement de sortie A/V, choisissez Final Cut Pro > Préférences (ou 
appuyez sur Commande +Virgule), cliquez sur Lecture, puis choisissez un dispositif dans la 
fenêtre Lecture des préférences.
4 Dans Final Cut Pro, choisissez Fenêtre > Sortie A/V.
Le contenu du visualiseur s’affiche sur le moniteur broadcast. Les fonctionnalités du visualiseur 
(par exemple, ses commandes à l’écran et les éléments venant se superposer sur la zone de titre 
ou d’action sécurisée) ne s’affichent que dans Final Cut Pro.
Remarque : la vidéo et l’audio sont synchronisés au niveau de l’image vidéo (et non de l’échantillonnage audio).
Pour désactiver la sortie A/V, choisissez Fenêtre > Sortie A/V.Chapitre 6 Lecture et survol du média 86
À propos du rendu en arrière-plan
Lorsque vous ajoutez des effets, des transitions, des générateurs, des titres ou autres éléments 
faisant appel à un rendu avant la lecture, l’indicateur de rendu en arrière-plan (représenté par un 
trait orange) apparaît en dessous du timecode sur la timeline. 
Indicateur de rendu 
en arrière-plan
Par défaut, le rendu en arrière-plan se lance après 5 secondes d’inactivité et d’immobilité du 
pointeur dans Final Cut Pro. Ce rendu en arrière-plan se poursuit si vous utilisez une autre application. Vous pouvez modifier ce réglage dans les préférences de Final Cut Pro.7
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Création d’un projet
Pour créer un film dans Final Cut Pro, vous devez créer au préalable un projet, qui contient tous 
vos choix de montage et les données utilisées. Vous devez ensuite ajouter les plans à la timeline 
du projet puis les monter.
Au moment de créer un projet Final Cut Pro, vous devez effectuer plusieurs choses:
• Attribuez un nom au projet.
• Indiquer un événement par défaut pour le projet.
L’événement par défaut stocke les données déposées sur le projet à partir du Finder ou d’un 
navigateur multimédia de Final Cut Pro. Si vous faites glisser le média depuis le Finder sur la 
timeline, il vient alors se placer automatiquement dans l’événement par défaut du projet.
Il vous est également possible de définir le timecode de début et les propriétés vidéo, audio et 
de rendu applicables au projet.
Après avoir créé votre projet, vous devez y ajouter des plans à partir de la bibliothèque 
d’événements.
Remarque : Si vous créez un projet et que vous n’avez pas encore importé de média dans 
Final Cut Pro, vous devez le faire à ce stade. Consultez la section Présentation de l’importation à 
la page 21 pour en savoir plus.
Début d’un projet
1 Procédez de l’une des manières suivantes:
• Dans Final Cut Pro, choisissez Fichier > Nouveau projet (ou appuyez sur Commande + N).
• Assurez-vous que la bibliothèque de projets est ouverte, puis cliquez sur le bouton 
Nouveau projet. 
2 Dans la fenêtre qui s’affiche, attribuez un nom au projet dans le champ Nom.
3 Choisissez un événement par défaut pour le projet.
Si vous faites glisser des fichiers multimédias directement du Finder vers la timeline du projet, ou 
si vous ajoutez des données au projet à l’aide de l’un des navigateurs multimédias, les données 
en question sont automatiquement ajoutées à l’événement par défaut du projet.
4 Si vous voulez personnaliser davantage les réglages pour votre projet, cliquez sur « Utiliser les 
réglages personnalisés ».
Remarque : Final Cut Pro affiche les réglages automatiques par défaut, mais conserve en 
mémoire ceux que vous avez utilisés en dernier. Cette étape peut dès lors s’avérer facultative.
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5 Si vous voulez que le timecode de votre projet commence par une autre valeur que 00:00:00:00, 
tapez une valeur de timecode de début dans le champ Timecode de début.
6 Pour apporter des modifications aux propriétés vidéo ou audio du projet, sélectionnez 
Personnaliser, puis utilisez les menus locaux à votre disposition.
À moins que vous n’ayez des besoins précis pour le projet que vous créez, il est préférable de 
laisser l’option «Définir automatiquement d’après le 1er plan vidéo » sélectionnée.
7 Cliquez sur OK.
Le nouveau projet s’affiche enfin dans la bibliothèque de projets avec le nom que vous lui avez 
attribué à l’étape 2.
Nouveau projet
Vous pouvez dès lors ajouter des plans depuis le navigateur d’événements et commencer à 
monter votre projet de façon plus poussée, par exemple en lui ajoutant des titres, des effets spé-
ciaux, de la musique de fond, des effets sonores, etc.
Vous pouvez modifier à tout moment le nom d’un projet, son événement par défaut ainsi que 
d’autres propriétés du projet. Consultez Modification du nom et des propriétés d’un projet à la 
page 89 pour en savoir plus.
Preview et ouverture d’un projet
Pour retrouver le contenu d’un projet, vous pouvez en effectuer le preview avant de l’ouvrir.
Preview d’un projet
1 Si la bibliothèque de projets n’est pas déjà ouverte, cliquez sur le bouton Bibliothèque de projets 
situé dans le coin inférieur gauche de la fenêtre principale de Final Cut Pro.
2 Sélectionnez un projet dans la bibliothèque de projets.
3 Pour effectuer un preview d’un projet dans le visualiseur, sélectionnez-le et procédez de l’une 
des manières suivantes:
• Pour survoler le projet: placez le pointeur sur la pellicule (située à droite du nom du projet).
• Pour lancer la lecture du projet à partir du skimmer (représenté par le trait vertical rose): appuyez 
sur la barre d’espace ; rappuyez dessus pour interrompre la lecture du projet.Chapitre 7 Création et gestion de projets 89
Ouverture d’un projet
1 Ouvrez la bibliothèque de projets.
2 Accédez au projet à ouvrir, puis double-cliquez dessus.
Modification du nom et des propriétés d’un projet
Au fur et à mesure de l’évolution de votre projet, il se peut que vous soyez amené à le renommer 
et à en modifier les propriétés.
Réattribution du nom d’un projet
1 Si la bibliothèque de projets n’est pas déjà ouverte, cliquez sur le bouton Bibliothèque de projets 
situé dans le coin inférieur gauche de la fenêtre principale de Final Cut Pro.
2 Sélectionnez un projet, puis cliquez sur le nom du projet pour le mettre en surbrillance.
3 Saisissez le nouveau nom du projet dans le champ Nom et appuyez sur Retour.
En fonction de l’agencement de votre bibliothèque de projets, la position du projet dans la liste 
peut changer après avoir renommé ce dernier.
Changement de l’événement par défaut et modification des propriétés d’un projet
Lorsque vous créez un projet, vous définissez ses propriétés et vous lui attribuez un événement 
par défaut destiné à stocker des données que vous avez fait glisser directement sur la timeline 
du projet depuis le Finder ou un navigateur multimédia de Final Cut Pro.
Dans la plupart des cas, Final Cut Pro gère automatiquement les propriétés du projet en se 
basant sur les propriétés du premier plan que vous ajoutez au projet ; vous pouvez toutefois modifier presque toutes les propriétés d’un projet. Si vous devez modifier les propriétés 
du projet, choisissez celles vidéo et audio selon le mode de partage de votre film final avec 
votre public.
1 Pour ce faire, ouvrez la bibliothèque de projets, puis sélectionnez un projet.
2 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Propriétés du projet (ou appuyez sur Commande + J).
• Si la fenêtre de l’inspecteur est masquée, cliquez sur le bouton Inspecteur dans la barre 
d’outils.
Cliquez ensuite sur le bouton Propriétés situé en haut de la fenêtre.
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3 Cliquez sur le bouton Propriétés du projet .
Bouton Propriétés 
du projet
4 Dans la fenêtre qui s’affiche, adaptez les réglages selon vos besoins.
Sélectionnez un 
présentation par défaut 
dans le menu local.
Modifiez les propriétés 
vidéo, audio et de 
rendu du projet.
Nom
• Nom : saisissez un nom pour le projet.
Événement par défaut
• Événement par défaut: choisissez l’événement par défaut du projet.
Timecode de début
• Timecode de début : si vous voulez que le timecode de votre projet commence par une autre 
valeur que 00:00:00:00, tapez une valeur de timecode de début.
Timecode Drop Frame
• Drop Frame : cochez cette case pour activer le timecode Drop Frame (option disponible uniquement pour les médias à 29,97 et 59,94 ips). 
Dans le timecode Non-Drop Frame le compteur de timecode défile à vitesse constante sans 
effectuer de sauts de valeur. Le timecode Non-Drop Frame est disponible comme option d’affichage pour toutes les fréquences d’images.
Dans le timecode Drop Frame, les images 0 et 1 sont ignorées au cours de la première seconde 
de chaque minute, sauf si le nombre de minutes est exactement divisible par 10.
Propriétés vidéo
• Format: choisissez le format vidéo (méthode particulière d’encodage vidéo).
• Résolution : choisissez la taille d’image de la vidéo.
• Fréquence : choisissez le nombre d’images par seconde (ips).
Remarque : Vous ne pouvez pas modifier la fréquence d’images d’un projet, sauf si la timeline 
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Propriétés audio et de rendu
• Canaux audio : choisissez s’il faut présenter l’audio sous forme de son Surround multicanal ou 
de son stéréo.
• Fréquence d’échantillonnage : choisissez la fréquence d’échantillonnage audio de votre projet 
(à savoir le nombre de fois qu’un signal est mesuré, c’est-à-dire échantillonné, par seconde). 
Plus la fréquence d’échantillonnage est supérieure, plus l’audio est de qualité élevée et plus les 
fichiers produits sont volumineux. La fréquence d’échantillonnage que vous choisissez dépend 
des données source que vous utilisez et de la destination finale de votre audio.
• Format du rendu :permet de choisir le codec à utiliser pour le rendu en arrière-plan de 
votre projet.
5 Cliquez sur OK.
Définition de l’ordre de référencement d’événements par un projet
Si vous avez des plans en double dans différents événements, il vous est possible de définir 
l’ordre dans lequel Final Cut Pro recherche les plans.
1 Pour ce faire, ouvrez la bibliothèque de projets, puis sélectionnez un projet.
2 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Propriétés du projet (ou appuyez sur Commande + J).
• Si la fenêtre de l’inspecteur est masquée, cliquez sur le bouton Inspecteur dans la barre 
d’outils.
Cliquez ensuite sur le bouton Propriétés situé en haut de la fenêtre.
Bouton Propriétés
3 Cliquez sur le bouton « Modifie les références aux événements » dans la section 
Événements référencés.Chapitre 7 Création et gestion de projets 92
4 Dans la fenêtre qui s’affiche, faites glisser les événements pour définir l’ordre dans lequel 
Final Cut Pro recherche les plans.
5 Une fois l’ordre établi, cliquez sur OK.
Organisation des projets dans la bibliothèque de projets
Tous vos projets vidéo Final Cut Pro sont répertoriés dans la bibliothèque de projets. Vous 
pouvez commencer l’organisation de vos projets en branchant des disques durs supplémentaires, en créant des dossiers pour y conserver des projets et en attribuant à ces derniers des 
noms évocateurs et précis. Au fur et à mesure que votre bibliothèque de projets grandit, vous 
pouvez renommer, copier, déplacer et supprimer vos projets selon vos besoins.
Utilisation de dossiers pour organiser les projets
1 Si la bibliothèque de projets n’est pas déjà ouverte, cliquez sur le bouton Bibliothèque de projets 
situé dans le coin inférieur gauche de la fenêtre principale de Final Cut Pro.
2 Sélectionnez un disque, un dossier ou un projet auquel vous voulez ajouter un dossier, puis cliquez sur le bouton Nouveau dossier situé dans le coin inférieur gauche de la fenêtre principale 
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Un nouveau dossier au nom évocateur apparaît sur le disque ou dans le dossier que vous avez 
sélectionné, ou au même niveau que le projet sélectionné.
3 Procédez de l’une des façons suivantes:
• Pour renommer le dossier: sélectionnez le dossier, cliquez sur son nom, puis attribuez-lui un 
nouveau nom.
• Pour ajouter un projet au dossier: faites glisser le projet sur le dossier.
• Pour ouvrir ou fermer le dossier: cliquez sur le triangle d’affichage à gauche du nom du dossier.
Copie d’un projet
Copier un projet s’avère utile pour travailler sur une nouvelle version ou pour transférer la copie 
sur un autre ordinateur.
1 Pour ce faire, ouvrez la bibliothèque de projets, puis sélectionnez un projet.
2 Choisissez Fichier > Dupliquer le projet.
3 Dans la fenêtre qui s’affiche, choisissez un emplacement pour le fichier dupliqué dans le menu 
local Emplacement.
4 Sélectionnez une option pour indiquer ce qui doit être dupliqué :
• Dupliquer le projet: copie uniquement le fichier du projet.
• Dupliquer le projet et les événements référencés: copie le fichier du projet, tout événement réfé-
rencé par le fichier du projet et l’intégralité du média inclus dans les événements référencés.
• Dupliquer le projet et les plans utilisés: copie le fichier du projet et les fichiers de média se rapportant à tout plan utilisé dans le projet.Chapitre 7 Création et gestion de projets 94
• Inclure les fichiers de rendu : cochez cette case pour inclure les fichiers de rendu pour les plans 
et les projets. Si vous voulez libérer de l’espace sur le disque dur, décochez cette case.
Choisissez un 
emplacement 
d’enregistrement 
du projet.
Sélectionnez une 
option pour la copie.
5 Cliquez sur OK.
Final Cut Pro copie le projet dans l’emplacement choisi d’après l’option indiquée. Le projet voit 
son nom complété d’un suffixe (par exemple « :film de François1 »), puis le projet s’affiche dans la 
bibliothèque de projets.
Copie rapide d’un projet sur un périphérique de stockage externe
m Ouvrez la bibliothèque de projets, sélectionnez un projet, puis faites glisser le projet sur l’icône 
du disque dur externe située dans la bibliothèque de projets.
Déplacement d’un projet
Vous avez la possibilité de déplacer un projet en toute simplicité vers un disque dur branché ou 
un autre ordinateur connecté. Le déplacement du fichier d’un projet s’avère utile si vous voulez 
travailler dessus en utilisant un autre ordinateur où Final Cut Pro est installé ou si vous cherchez à 
libérer de l’espace sur le disque dur de votre ordinateur.
Important : Impossible d'annuler un déplacement de projet avec la commande Annuler.
1 Pour ce faire, ouvrez la bibliothèque de projets, puis sélectionnez un projet.
2 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Déplacer le projet.
• Maintenez la touche Commande enfoncée pendant le glissement du projet sur l’icône d’un 
autre disque dur externe reprise dans la bibliothèque de projets.
3 Dans la fenêtre qui s’affiche, choisissez un emplacement cible du projet (à savoir un disque dur 
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4 Sélectionnez une option pour indiquer ce qui doit être déplacé :
• Déplacer le projet: déplace uniquement le fichier du projet.
• Déplacer le projet et les événements référencés: déplace le fichier du projet, tout événement réfé-
rencé par le fichier du projet et l’intégralité du média inclus dans les événements référencés. 
Sélectionnez 
l’emplacement vers 
lequel vous souhaitez 
déplacer le projet.
Sélectionnez une 
option pour le 
déplacement.
5 Cliquez sur OK.
Final Cut Pro déplace le projet à l’emplacement choisi d’après l’option que vous avez indiquée. 
Consultez la section Emplacement de vos fichiers de média et de projet à la page 407 pour en 
savoir plus sur l’emplacement par défaut des projets Final Cut Pro et des événements.
Suppression d’un projet ou de son dossier
La suppression du dossier d’un projet entraîne également celle de tous les projets qu’il contient. 
Votre média n’est pas pour autant supprimé car il est stocké dans les événements.
1 Pour ce faire, ouvrez la bibliothèque de projets, puis sélectionnez un projet.
2 Procédez de l’une des manières suivantes:
• Pour supprimer un projet: sélectionnez le projet, puis choisissez Fichier > Placer le projet dans la 
Corbeille (ou appuyez sur Commande + Supprimer).
• Pour supprimer un dossier et tout projet que le dossier contient: sélectionnez le dossier, puis choisissez Fichier > Placer le dossier dans la Corbeille (ou appuyez sur Commande + Supprimer).
Le projet ou son dossier (ainsi que les projets qu’il contient) est alors supprimé de la bibliothèque de projets et placé dans la Corbeille du Finder.
3 Pour supprimer de façon permanente le projet ou le dossier d’un projet ainsi que ses fichiers et 
libérer de l’espace sur votre disque dur, videz la Corbeille du Finder.
AVERTISSEMENT : Une fois la Corbeille vidée, le fichier ou le dossier ne peut plus être récupéré.
Il vous est également possible de supprimer les fichiers de rendu d’un projet. Consultez Affichage 
des tâches d’arrière-plan à la page 418 pour en savoir plus.Chapitre 7 Création et gestion de projets 96
Enregistrement des projets
Final Cut Pro enregistre en effet automatiquement toutes les modifications que vous apportez au 
fur et à mesure de vos manipulations dans le projet, plutôt que de vous obliger à le faire manuellement. Vous pouvez en outre annuler toutes vos modifications jusqu’au moment de la dernière 
fermeture et réouverture de Final Cut Pro, en choisissant Édition > Annuler (ou en appuyant sur 
Commande + Z).
Vous pouvez créer plusieurs versions d'un projet en le dupliquant. Pour en savoir plus sur la 
duplication de projets, consultez la section Organisation des projets dans la bibliothèque de projets à la page 92.
Les modifications que vous apportez à un plan dans un projet n’influe pas sur son fichier source. 
Ainsi, si vous avez réalisé de nombreux changements dans un plan mais voulez repartir depuis 
le début, vous pouvez restaurer facilement le plan à son état d’origine en ajoutant une nouvelle 
copie du plan (accessible depuis la bibliothèque d’événements) à votre projet.8
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Présentation du montage
Le terme montage vidéo fait référence à la fois aux grandes étapes du flux de production d’un 
projet et aux tâches manuelles très spécifiques que vous réalisez sur les plans dans la timeline 
d’un projet.
• Sélections et ajout de plans à la timeline : l’ajout et l’organisation de plans dans votre projet 
constituent la base de la création d’un film avec Final Cut Pro. Vous déplacez et organisez les 
plans dans la timeline. Consultez les sections Présentation de l’ajout de plans à la page 106, 
Disposition des plans dans la timeline à la page 124 et Présentation de l’audio à la page 164. 
• Coupe et trim des plans: Final Cut Pro fournit de nombreux outils pour ajuster les points de 
départ et d’arrivée des plans dans la timeline et pour contrôler le passage d’un plan au suivant. Consultez Présentation du trim à la page 130. 
• Ajustement précis de votre projet: Final Cut Pro fournit de nombreux outils de montage avancé 
pour procéder facilement à la finition d’un film parfaitement abouti. Consultez les rubriques 
de la section relative au montage avancé.
• Ajout d’effets et étalonnage : les touches finales incluent les effets visuels et l’étalonnage. 
Consultez les sections Présentation des transitions, des titres, des effets et des générateurs à la 
page 212 et Présentation de l’étalonnage à la page 371.
Sélection de plans et de plages
À propos des sélections et des pellicules de film
L’étape de base du montage d’un projet vidéo consiste à choisir ce que vous voulez inclure dans 
le film final. Dans Final Cut Pro, vous indiquez les plans ou les parties de plans sur lesquels vous 
voulez réaliser une action en effectuant une sélection. Final Cut Pro offre de nombreux outils 
puissants pour effectuer des sélections rapidement et avec précision, notamment les pellicules, 
qui sont des séries de vignettes. Vos plans vidéo apparaissent sous forme de pellicules dans la 
timeline (là où vous créez vos projets) et dans le navigateur d’événements (là où sont affichées 
vos données source). Une seule pellicule vidéo peut représenter plusieurs secondes de vidéo 
regroupant des centaines d’images vidéo (à savoir des images spécifiques). Les clips exclusivement audio se présentent comme des formes d’onde audio, affichant les changements de 
volume dans le temps.
Lorsque vous ajoutez des plans à la timeline d’un projet depuis le navigateur d’événements, vous 
pouvez ajouter un ou plusieurs plans complets, ou une plage au sein d’un plan. Vous pouvez 
ensuite affiner séparément les plans dans la timeline, par exemple en leur ajoutant des effets 
vidéo ou en insérant des transitions entre eux. 
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Vous pouvez régler l’apparence des pellicules dans le navigateur d’événements et dans la timeline afin de simplifier les sélections. Par exemple, développer la largeur d’une pellicule (en réduisant la durée affichée par chaque vignette) vous permet d’effectuer des sélections plus précises.
Pellicule développée dans le 
navigateur d’événements pour 
des sélections précises
Vous pouvez également modifier l’aspect des pellicules dans la timeline pour pouvoir visualiser 
et sélectionner plus facilement les formes d’onde audio.
Aspect de la pellicule 
modifié pour faciliter 
la visualisation et la 
sélection des formes 
d’onde audio
Sélection d’un ou plusieurs plans
Les plans représentent vos fichiers vidéo, audio et graphiques et vous permettent de manipuler 
vos données dans Final Cut Pro sans modifier ces fichiers. Pour ajouter des plans à votre projet, 
les réorganiser ou leur appliquer des trims, vous devez d’abord les sélectionner. Il vous est possible de sélectionner un seul plan ou plusieurs plans en même temps.
La sélection de plusieurs plans vous permet de les déplacer au sein de votre projet, ou d’un évé-
nement à un autre, comme s’il s’agissait d’un groupe. Cela s’avère également utile si vous avez 
apporté des modifications à un plan et que vous voulez appliquer les mêmes modifications à 
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Sélection d’un plan complet
Procédez de l’une des manières suivantes:
m Cliquez une fois sur le plan.
m Placez le skimmer ou la tête de lecture sur un plan et appuyez sur X.
Remarque : Cela génère une sélection de plage qui correspond aux bords du plan.
m Dans le navigateur d’événements, appuyez sur la Flèche vers le haut ou Flèche vers le bas pour 
déplacer la sélection sur un plan adjacent.
m Dans le navigateur d’événements, tout en maintenant la touche Option enfoncée, faites glisser le 
pointeur du point de départ au point d’arrivée du plan.
m Dans la timeline, placez le skimmer (ou la tête de lecture si le survol est désactivé) sur le plan que 
vous voulez sélectionner, puis appuyez sur la touche C. Cette méthode sélectionne le plan dans 
le scénario principal.
Les plans et les scénarios connectés sont associés aux plans figurant dans le scénario principal 
et apparaissent au-dessus et en dessous de celui-ci. Pour sélectionner un plan ou un scénario 
connecté avec cette méthode « touche C », placez le pointeur sur le plan connecté, puis appuyez 
sur la touche C. Pour en savoir plus, consultez les sections Connexion de plans pour ajouter 
des prises, des titres et des effets de son synchronisés à la page 110 et Ajout de scénarios à la 
page 274.
Une bordure jaune apparaît autour du plan pour indiquer qu’il est sélectionné.
Remarque : Une sélection de plan dans la timeline (illustrée ci-dessus) se distingue sur les plans 
visuels et fonctionnels d’une sélection de plage dans la timeline, qui présente des poignées distinctes permettant d’ajuster ses points de départ et d’arrivée. Toutes les sélections dans le navigateur d’événements représentent en fait des sélections de plage (dont les points de départ et 
d’arrivée sont réglables)
Sélection de plusieurs plans dans le navigateur d’événements ou la timeline
m Pour sélectionner plusieurs plans individuels: cliquez sur les plans à sélectionner tout en maintenant la touche Commande enfoncée.
Remarque : Cliquez sur un plan du navigateur d’événements comportant des plages établies 
tout en maintenant la touche Commande enfoncée entraîne la sélection des plages plutôt que 
du plan entier.
m Pour sélectionner tous les plans et plages présents dans le navigateur d’événements ou la timeline : 
Cliquez sur Navigateur d’événements ou sur Timeline pour l’activer, puis choisissez Édition > Tout 
sélectionner (ou appuyez sur Commande + A).Chapitre 8 Montage de votre projet 100
m Pour sélectionner plusieurs plans par glissement: tracez un rectangle de sélection englobant les 
plans à sélectionner dans la timeline ou le navigateur d’événements.
Désélection de plans dans le navigateur d’événements ou la timeline
m Pour désélectionner un seul plan : cliquez sur le plan en maintenant la touche Commande enfoncée ou cliquez hors du plan sélectionné (ou sélectionner un autre plan).
m Pour désélectionner plusieurs plans: cliquez sur les plans à désélectionner tout en maintenant la 
touche Commande enfoncée.
m Pour désélectionner tous les plans et plages: choisissez Édition > Sélectionner > Aucun (ou 
appuyez sur les touches Commande + Maj + A).
m Pour désélectionner tous les plans et plages dans le navigateur d’événements: Appuyez simultané-
ment sur les touches + X.
Sélection d’une plage
Au lieu de sélectionner des plans complets, vous pouvez sélectionner une plage au sein d’un 
plan dans la timeline ou le navigateur d’événements. Dans la timeline, vous pouvez également 
sélectionner une plage couvrant plusieurs plans. Vous pouvez appliquer des trims aux sélections 
de plage, leur attribuer des classements et des mots-clés et les modifier de toute autre manière. 
Vous pouvez ajuster les points de départ et d’arrivée d’une sélection de plage en faisant glisser 
l’un des bords figurant de part et d’autre de celle-ci. Vous pouvez également créer différentes 
sélections de plage sur un ou plusieurs plans dans le navigateur d’événements.
Poignées de plage
Remarque : Cette illustration reprend une sélection de plage dans la timeline. Les sélections de 
plage du navigateur d’événements possèdent des poignées de plage droites.Chapitre 8 Montage de votre projet 101
Sélection d’une plage
Procédez de l’une des manières suivantes:
m Dans le navigateur d’événements, faites glisser le pointeur sur un plan (pellicule). 
La plage sélectionnée est encadrée en jaune.
Si la pellicule s’étend sur deux lignes et que vous souhaitez prolonger la sélection sur la seconde 
ligne, il vous suffit de continuer à faire glisser le pointeur au-delà du point de retour à la ligne. 
Lorsque vous atteignez le bord, le pointeur passe à la ligne suivante.
Conseil : Dans le navigateur d’événements, faites glisser le pointeur tout en maintenant la 
touche Option enfoncée sur un plan (ou pellicule) quelconque où des plages sont déjà établies 
pour remplacer ces dernières par la nouvelle plage.
m Dans la timeline, choisissez Sélection de plage dans le menu local Outils situé sur la barre d’outils 
(ou appuyez sur R).
Le pointeur prend la forme de l’outil Sélection de plage . 
Faites glisser l’outil Sélection de plage sur un ou plusieurs plans dans la timeline pour sélectionner une plage. Pour ajuster les points de départ et d’arrivée de la sélection de plage, faites glisser 
les poignées figurant de part et d’autre de la plage.
Conseil : Pour activer temporairement l’outil Sélection de plage, maintenez la touche R enfoncée. 
Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.
Poignées de plage
m Utilisez les touches I et O pour définir les points de départ et d’arrivée de la sélection de plage. 
Pour en savoir plus, reportez-vous aux instructions ci-dessous. 
m Dans le navigateur d’événements ou la timeline, placez le skimmer (ou la tête de lecture) sur un 
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Final Cut Pro définit les points de départ et d’arrivée de la sélection de plage sur ceux du plan.
Conseil : Pour utiliser cette méthode « touche X » avec des plans connectés ou des plans figurant 
dans un scénario connecté, placez le pointeur sur le plan, puis appuyez sur la touche X.
m Tout en maintenant la touche Commande enfoncée, cliquez sur un trait de marqueur coloré en 
haut d’un plan.
Ces traits permettent d’indiquer un élément particulier parmi les suivants: favori (vert), rejeté 
(rouge), mots-clé ajoutés manuellement (bleu) ou mots-clés d'analyse (violet).
Définition du point de départ ou d’arrivée d’une plage
m Pour définir le point de départ: placez le skimmer (ou la tête de lecture, si le survol est désactivé) à 
l’endroit où vous voulez que la sélection commence, puis choisissez Marquer > Définir le début 
de la plage (ou appuyez sur la touche I). 
 Pour supprimer le point de départ de la plage, appuyez sur Option + I.
m Pour définir le point d’arrivée : placez le skimmer (ou la tête de lecture, si le survol est désactivé) 
à l’endroit où vous voulez que la plage se termine, puis choisissez Marquer > Définir la fin de la 
plage (ou appuyez sur la toucheO). 
Pour supprimer le point d’arrivée de la plage, appuyez sur Option +O.
m Pour régler le point de départ ou d’arrivée de la plage pendant la lecture d’un plan ou de votre 
projet: appuyez sur la barre d’espace pour lancer la lecture, puis appuyez sur la touche I ouO au 
moment où vous voulez définir le point de départ ou d’arrivée. 
Conseil : Dans le navigateur d’événements, il vous est aussi possible d’appuyer sur 
Commande + Maj + I et sur Commande + Maj +O pour définir plusieurs plages au cours de 
la lecture.
Si vous utilisez les outils Lame de rasoir, Trim et Sélection de plage dans la timeline ou l’éditeur 
de précision, vous pouvez utiliser les touchesI etO pour définir les points de départ et d’arrivée 
d’une sélection dans un plan ou un scénario connecté, ainsi que dans les plans figurant sous les 
plans et les scénarios connectés. Placez le pointeur directement sur un plan, puis appuyez sur la 
touche I pour définir le point de départ ou sur la toucheO pour définir le point d’arrivée.
Prolongement ou raccourcissement de la sélection de plage
m Pour modifier le début ou la fin de la plage : faites glisser le côté gauche ou droit de la bordure de 
sélection jaune.
m Pour réinitialiser le point de départ ou d’arrivée d’une plage au sein du même plan d’événement ou du 
projet: déplacez le skimmer et appuyez sur la touche I ou O.
Conseil : Vous pouvez également appuyer sur la touche I ou O pendant la lecture d’un plan.
m Pour prolonger ou raccourcir une plage au sein d’un plan d’événement: placez le skimmer sur 
l’image à laquelle vous voulez que la plage commence ou se termine, puis cliquez (ou faites glisser le pointeur) tout en maintenant la touche Maj enfoncée. 
m Pour étendre ou raccourcir une plage à l’aide du timecode : choisissez Modifier > Modifier la durée 
(ou appuyez sur Contrôle +D), puis saisissez la nouvelle durée. (Cela ne fonctionne qu’avec des 
sélections de plage simples.)
La sélection de plage est prolongée ou raccourcie en conséquence.
Si vous avez besoin du skimmer et qu’il est absent, vous pouvez activer le survol à tout moment.Chapitre 8 Montage de votre projet 103
Définition de plusieurs plages dans des plans d’événement au cours de la lecture
Il vous est possible de définir plusieurs plages dans des plans repris dans le navigateur d’événements au cours de la lecture.
1 Reproduisez un plan d’un événement.
2 Lors de la lecture du plan, effectuez l’une des opérations suivantes:
• Pour ajouter le point de départ d’une plage : appuyez sur Commande + Maj + I.
• Pour ajouter le point d’arrivée d’une plage : appuyez sur Commande + Maj +O.
Remarque : Pour définir plusieurs plages dans le même plan, répétez ces raccourcis clavier pendant que la lecture s’effectue.
Définition de la sélection de plage coïncidant avec les bords du plan
m Placez le skimmer ou la tête de lecture sur un plan et appuyez sur X.
Final Cut Pro définit une sélection de plage depuis le point de départ au point d’arrivée du plan. 
Toute sélection préalablement établie est alors supprimée.
Effacement des plages
Vous pouvez supprimer une ou plusieurs plages dans le navigateur d’événements ou la timeline.
Remarque : Cette opération n’influe en rien sur le média du plan, que ce soit dans le navigateur 
d’événements ou dans la timeline.
m Pour supprimer une plage particulière dans un événement: cliquez sur la plage tout en maintenant 
la touche Option enfoncée.
m Pour supprimer la sélection d’une plage dans la timeline : cliquez à l’extérieur de la plage ou sélectionnez-en une autre.
m Pour effacer une ou plusieurs plages dans le navigateur d’événements ou la timeline : sélectionnez 
la ou les plages et appuyez sur Marquer > Effacer les plages sélectionnées (ou appuyez sur 
Option + X).
Remarque : Les plages sélectionnées sont encadrées en jaune. Celles désélectionnées (disponibles uniquement dans le navigateur d’événements) présentent une bordure fine orange.
m Pour supprimer toutes les plages d’un événement: choisissez Édition > Tout sélectionner (ou 
appuyez sur Commande + A) pour sélectionner toutes les plages de l’événement actif, puis choisissez Marquer > Effacer les plages sélectionnées (ou appuyez sur Option + X).
Gestion de plusieurs sélections de plage dans des plans d’événement
Dans le navigateur d’événements, vous avez la possibilité de définir plusieurs plages dans un ou 
plusieurs plans et vous pouvez sélectionner et désélectionner des plages après les avoir établies. 
Par exemple, vous pouvez définir plusieurs plages dans un plan d’événement long, puis désélectionner certaines de ces plages avant d’ajouter à la timeline toutes les plages sélectionnées en 
une seule fois.Chapitre 8 Montage de votre projet 104
Remarque : Les plages sélectionnées sont encadrées en jaune. Les plages désélectionnées 
présentent un cadre fin orange. Les commandes de montage manipulent uniquement les 
sélections jaunes.
Plages sélectionnées Plages non sélectionnées
Remarque : Les commandes décrites dans cette section supposent que le navigateur d’événements soit l’élément actif de l’interface de Final Cut Pro. Pour activer le navigateur d’événements, 
déplacez le pointeur dessus ou cliquez dessus. Lorsque le navigateur d’événements est actif, son 
arrière-plan se présente en gris plus clair.
Réglage de plusieurs plages sur un plan d’événement
1 Dans le navigateur d’événements, sélectionnez une plage au sein d’un même plan.
2 Pour définir une autre plage, effectuez l’une des opérations suivantes:
• Faites glisser, tout en maintenant la touche Commande enfoncée, une autre section du plan.
• Placez le skimmer ou la tête de lecture sur l’image où vous voulez que commence une plage 
supplémentaire et appuyez sur Commande + Maj + I. Placez le skimmer ou la tête de lecture 
sur l’image où doit se terminer la nouvelle plage et appuyez sur Commande + Maj +O.
Remarque : Ces raccourcis clavier fonctionnent également pendant la lecture pour vous permettre de régler des plages supplémentaires à la volée. 
• Faites glisser, tout en maintenant la touche Option enfoncée, le pointeur sur ou au sein de 
plages pour les remplacer par une nouvelle plage.
• Tout en maintenant la touche Commande enfoncée, cliquez sur un trait de marqueur coloré 
en haut d’un plan.
Ces traits permettent d’indiquer un élément particulier parmi les suivants: favori (vert), rejeté 
(rouge), mots-clé ajoutés manuellement (bleu) ou mots-clés d'analyse (violet).
La sélection de plage supplémentaire apparaît dans le plan.Chapitre 8 Montage de votre projet 105
Pour désélectionner une plage, cliquez dessus tout en maintenant la touche Option enfoncée.
Sélection et désélection de plages et de plans dans un événement
Vous avez la possibilité de définir, de sélectionner ou de désélectionner plusieurs plages à l’inté-
rieur de plans d’événement ou d’événements.
Important : Les commandes de montage manipulent uniquement les sélections jaunes. Les commandes de montage ignorent les plages orange (désélectionnées).
Plages sélectionnées Plages non sélectionnées
m Pour sélectionner une plage indépendamment: cliquez sur la plage.
m Pour sélectionner ou désélectionner une plage : cliquez sur la plage tout en maintenant la touche 
Commande enfoncée.
m Pour sélectionner toutes les plages d’un plan : cliquez sur une zone du plan où aucune plage 
n’est définie.
m Pour sélectionner toutes les plages et tous les plans de l’événement actif : choisissez Édition > Tout 
sélectionner (ou appuyez sur les touches Commande + A).
Les plages (ainsi que tous les plans sans plage) s’encadrent alors en jaune pour indiquer qu’elles 
sont sélectionnées. 
m Pour désélectionner toutes les plages et tous les plans de l’événement actif : choisissez Édition > Tout 
désélectionner (ou appuyez sur les touches Commande + Maj + A). 
Les plages deviennent alors orange.
Annulation de la sélection de plages dans des plans d’un événement
Vous pouvez supprimer des plages particulières, plusieurs plages ou même toutes les plages 
incluses dans l’événement actif.
m Pour supprimer une plage particulière dans un événement: cliquez sur la plage tout en maintenant 
la touche Option enfoncée.
m Pour annuler les plages sélectionnées dans un événement: sélectionnez les plages à supprimer, puis 
choisissez Marquer > Effacer les plages sélectionnées (ou appuyez sur Option + X).
m Pour supprimer toutes les plages d’un événement: choisissez Édition > Tout sélectionner (ou 
appuyez sur Commande + A) pour sélectionner toutes les plages de l’événement actif, puis choisissez Marquer > Effacer les plages sélectionnées (ou appuyez sur Option + X).
Navigation entre les sélections dans un événement
m Pour atteindre le début de la sélection de plage : choisissez Marquer > Aller à > Début de la plage 
(ou appuyez sur Maj + I).
Répétez cette commande pour accéder au début de la sélection de plage précédente ou au 
début du plan. 
m Pour atteindre la fin de la sélection de plage : choisissez Marquer > Aller à > Fin de la plage (ou 
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Répétez cette commande pour accéder à la fin de la sélection de plage suivante ou à la fin 
du plan.
m Pour sélectionner le plan précédent (ou ses plages): appuyez sur Flèche vers le haut.
Pour ajouter à la sélection, appuyez sur Maj + Flèche vers le haut. 
m Pour sélectionner le plan suivant (ou ses plages): appuyez sur Commande + Flèche vers le bas.
Pour ajouter à la sélection, appuyez sur Maj + Flèche vers le bas. 
Ajout et suppression de plans
Présentation de l’ajout de plans
Pour créer un projet de film, vous ajoutez des plans à la timeline dans un ordre chronologique. 
Vous disposez d’un grand choix d’outils et de techniques pour ajouter des plans selon vos 
besoins ou votre style de montage. Vous pouvez réorganiser à tout moment les plans dans 
la timeline.
Dans Final Cut Pro, vous pouvez monter vos projets sans vous soucier de la connexion ou de 
la synchronisation entre les plans. Par exemple, si vous faites glisser un plan dans la timeline, 
Final Cut Pro réorganise automatiquement celle-ci pour insérer le nouveau plan sans déranger 
le travail déjà réalisé. Cela est vrai pour tous les types de plans: vidéo, audio, titres, générateurs, 
images fixes, etc.
Vous pouvez utiliser les plans de plusieurs événements dans un même projet. Vous pouvez 
également ajouter des plans depuis les navigateurs multimédias de Final Cut Pro et le Finder. La 
suppression de plans de la timeline n’a aucun impact sur les plans ou les fichiers présents dans le 
navigateur d’événements, les navigateurs multimédias ou le Finder.
Les plans et les scénarios connectés restent associés (et synchronisés) aux plans figurant dans le 
scénario principal jusqu’à ce que vous les déplaciez ou les supprimiez explicitement.
Plan connecté
Plan connecté ne contenant 
que des données audio
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Glissement de plans vers la timeline
Vous pouvez ajouter des plans à la timeline en les faisant glisser depuis le navigateur d’événements, un navigateur multimédia de Final Cut Pro (tel que le navigateur de photos ou de générateurs) ou le Finder.
Glissement de plans depuis le navigateur d’événements ou un navigateur multimédia
1 Procédez de l’une des manières suivantes:
• Dans la bibliothèque d’événements, sélectionnez l’événement contenant les plans que vous 
voulez ajouter à votre projet.
• Ouvrez le navigateur multimédia contenant les données que vous voulez ajouter à 
votre projet.
2 Faites glisser un ou plusieurs plans du navigateur d’événements ou d’un navigateur multimédia 
vers la timeline.
Selon l’endroit où vous déposez les plans dans la timeline, vos actions peuvent entraîner un 
montage par ajout, insertion, connexion ou remplacement. Final Cut Pro règle automatiquement 
les plans adjacents pour faire tenir tous les plans que vous avez fait glisser.
Conseil : Vous pouvez ajouter un plan à la fois à votre projet ; cependant, il est parfois plus facile 
d’ajouter plusieurs plans en même temps et de les réorganiser par la suite dans la timeline.
Glissement de fichiers depuis le Finder
1 Disposez les fenêtres à l’écran de façon à voir à la fois la fenêtre principale de Final Cut Pro et les 
fichiers dans le Finder.
2 Faites glisser les fichiers du Finder vers la timeline.
Selon l’endroit où vous déposez les plans dans la timeline, vos actions peuvent entraîner un 
montage par ajout, insertion, connexion ou remplacement. 
Remarque : Si vous ajoutez des plans à la timeline depuis un navigateur multimédia de 
Final Cut Pro ou le Finder, vous importez les données dans l’événement par défaut associé au 
projet en cours. Vous pouvez configurer l’événement par défaut dans la fenêtre des réglages du 
projet. Final Cut Pro applique alors les réglages d’optimisation et d’analyse par défaut aux nouveaux plans. Vous pouvez définir les traitements d’optimisation et d’analyse par défaut dans les 
préférences de Final Cut Pro.
Si vous ajoutez des images fixes à la timeline, elles ont une durée de 4 secondes par défaut. Vous 
pouvez modifier cette durée par défaut dans les préférences de Final Cut Pro. 
Ajout de plans à votre projet 
Vous pouvez ajouter simplement un plan à votre projet en procédant à un montage par ajout, 
qui consiste à ajouter un ou plusieurs plans à la fin d’un projet ou d’un scénario.
Ajout de plans à votre projet dans la timeline 
1 Sélectionnez un ou plusieurs plans dans le navigateur d’événements.
2 Pour ajouter les plans à la timeline, effectuez l’une des opérations suivantes:
• Choisissez Édition > Ajouter à la fin (ou appuyez sur la touche E).Chapitre 8 Montage de votre projet 108
• Dans la barre d’outils, cliquez sur le bouton Ajouter.
Si aucun élément n’est sélectionné, le plan apparaît à la fin du scénario principal dans la timeline. 
Si un scénario est sélectionné, le plan apparaît à la fin de celui-ci.
Insertion de plans dans votre projet
Un montage par insertion place le plan source de façon à ce que tous les plans situés après le 
point d’insertion soient déplacés vers l’avant (Ripple) dans la timeline pour faire de la place au 
plan inséré. Aucun plan n’est supprimé de votre projet. Un montage par insertion allonge le 
projet de la durée du plan inséré. 
D A B C
A D B C
Après montage
Avant montage
Vous pouvez recourir au montage par insertion lorsque vous souhaitez ajouter un plan au début 
ou au milieu de votre projet. Vous pouvez également réaliser ce type de montage pour interrompre l’action dans un plan par celle dans le plan inséré. L’action du plan d’origine reprend 
ensuite, au terme du plan inséré.
Remarque : Vous pouvez utiliser un montage à trois points pour réaliser un montage par insertion. Pour en savoir plus, consultez Présentation du montage à trois points à la page 284.
Insertion de plans du navigateur d’événements dans la timeline
1 Sélectionnez un ou plusieurs plans dans le navigateur d’événements.
2 Placez la tête de lecture sur le point où vous voulez insérer le plan dans le scénario principal ou 
un scénario sélectionné (ou effectuez une sélection de plage).
3 Procédez de l’une des manières suivantes:
• Choisissez Édition > Insérer (ou appuyez sur la toucheW).
Remarque : Si vous utilisez le raccourci clavier et que le skimmer est présent dans la timeline, 
le montage est réalisé au niveau de ce dernier.
• Dans la barre d’outils, cliquez sur le bouton Insérer.
Le plan apparaît dans la timeline et tous les plans situés après le point d’insertion sont déplacés 
vers l’avant. Si le skimmer est absent, les plans sont insérés au niveau de la tête de lecture. Si 
vous effectuez un montage par insertion au milieu d’un plan existant dans la timeline, celui-ci est 
coupé au niveau du point d’insertion et la seconde moitié est repoussée à la fin du plan inséré, 
avec le reste du métrage situé après le point d’insertion. Chapitre 8 Montage de votre projet 109
Insertion d’un plan vide ou de repère d’emplacement dans la timeline
Il se peut que vous ayez besoin de réserver un espace dans la timeline pour un plan que vous 
n’avez pas encore. Final Cut Pro offre deux solutions à ce problème : des images de repère d’emplacement ou un plan vierge et sans son appelé plan vide dont vous pouvez définir librement 
la durée.
1 Placez la tête de lecture sur le point où vous voulez insérer le plan vide ou de repère d’emplacement dans le scénario principal ou un scénario sélectionné (ou effectuez une sélection de plage).
2 Effectuez l’une des opérations suivantes:
• Pour insérer un plan de repère d’emplacement: choisissez Édition > Insérer le repère d’emplacement (ou appuyez sur Commande +Option +W).
Final Cut Pro insère des images de repère d’emplacement grises que vous pouvez personnaliser. Pour en savoir plus, consultez Utilisation d’un repère d’emplacement à la page 247. Vous 
pouvez définir librement la durée des plans de repère d’emplacement.
Plan de repère 
d’emplacement
• Pour insérer un plan vide : choisissez Édition > Insérer un espace (ou appuyez sur Option +W).
Final Cut Pro insère un plan vierge (contenant de la vidéo vierge et du silence) dont vous 
pouvez définir librement la durée. (L’industrie audiovisuelle emploie le terme d’amorce pour le 
désigner.)
Plan vide
Remarque : La couleur du plan vide se détermine par celle de l’arrière-plan actif dans 
Final Cut Pro. Pour définir celle-ci, choisissez une option Arrière-plan du lecteur dans la fenêtre 
Lecture des préférences de Final Cut Pro. Si vous voulez une autre couleur, envisagez d’utiliser 
un générateur de couleur unie.
Le plan apparaît dans la timeline et tous les plans situés après le point d’insertion sont déplacés 
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Insertion de plans par glissement depuis le navigateur d’événements, un navigateur multimé-
dia ou le Finder
Vous pouvez insérer des plans entre ceux présents dans la timeline en les faisant glisser depuis le 
navigateur d’événements, un autre navigateur multimédia de Final Cut Pro ou le Finder.
m Faites glisser le plan à insérer sur un point de montage (entre deux plans) dans la timeline.
Le plan apparaît dans la timeline et tous les plans situés après le point d’insertion sont déplacés 
vers l’avant (la droite).
Connexion de plans pour ajouter des prises, des titres et des effets de son 
synchronisés
Vous pouvez associer des plans entre eux dans la timeline. Les plans connectés restent reliés et 
synchronisés jusqu’à ce que vous les déplaciez ou les supprimiez manuellement. 
A B C
D
A B C
D
Après montage
Avant montage
Voici quelques utilisations possibles des plans connectés:
• Plans de coupe : ajout d’un plan de coupe en le connectant à un plan vidéo dans la timeline.
• Titres superposés: ajout d’un titre ou d’un tiers inférieur à un plan vidéo ou à une plage. 
• Effets sonores et musique de fond : synchronisation de clips audio avec des plans du scénario 
principal. Les plans restent synchronisés même si vous déplacez les plans du scénario principal.Chapitre 8 Montage de votre projet 111
Lorsque vous utilisez la commande de menu, le raccourci clavier ou le bouton de barre d’outils 
Connecter, les plans vidéo (bleus) sont connectés au-dessus du scénario principal, et les clips 
audio (verts) sont connectés en dessous:
Plan connecté
Plan connecté ne contenant 
que des données audio
Scénario principal
Remarque : Vous pouvez utiliser un montage à trois points pour réaliser un montage par 
connexion. Pour en savoir plus, consultez Présentation du montage à trois points à la page 284.
Connexion de plans dans la timeline 
1 Si votre projet est vide, ajoutez des plans à la zone gris foncé du scénario principal dans la timeline pour créer votre séquence initiale.
 Les plans du scénario principal constituent une base à laquelle vous pouvez connecter (associer) d’autres plans pour développer votre projet. Les montages par connexion sont légèrement 
différents des autres types de montage en ce sens qu’ils n’ajoutent jamais de plans au scénario 
principal. Si vous réalisez un montage par connexion dans une timeline vide, Final Cut Pro ajoute 
d’abord un plan vide au scénario principal et lui associe le nouveau plan connecté.
2 Sélectionnez un ou plusieurs plans ou une plage dans le navigateur d’événements.
3 Effectuez l’une des opérations suivantes pour indiquer l’endroit où vous voulez connecter le plan 
source sélectionné :
• Placez la tête de lecture sur l’image du plan dans le scénario principal.Chapitre 8 Montage de votre projet 112
• Sélectionnez une plage dans le scénario principal.
4 Pour connecter les plans sélectionnés aux plans du scénario principal, effectuez l’une des opérations suivantes:
• Choisissez Édition > Connecter au scénario principal (ou appuyez sur la toucheQ).
Remarque : Si vous utilisez le raccourci clavier et que le skimmer est présent dans la timeline, 
le plan est connecté au niveau de ce dernier.
• Dans la barre d’outils, cliquez sur le bouton Connecter.
• Faites glisser les plans vers la zone grise au-dessus ou en dessous du scénario principal.
La première image de la sélection source est connectée au plan du scénario principal au niveau 
de la tête de lecture ou du skimmer. Si vous avez fait glisser la sélection source vers la timeline, 
sa première image est connectée au scénario principal à l’endroit où vous avez relâché le bouton 
de la souris.
Point de connexion
Plan connecté
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Lorsque vous réorganisez, déplacez, propagez ou supprimez des plans dans le scénario principal, 
les plans qui y sont connectés sont déplacés (ou supprimés) avec eux. 
Lorsque vous connectez des plans en les faisant glisser, vous avez la possibilité de placer les 
plans vidéo en dessous du scénario principal et les clips audio au-dessus.
Plan connecté ne 
contenant que des 
données audio
Plan audio/vidéo 
connecté
Titre
Remarque : Dans Final Cut Pro, si vous connectez des plans, les plans vidéo situés au-dessus 
masquent ceux se trouvant en dessous. Cela ne s’applique toutefois pas aux plans présentant 
certains réglages de transparence, d’incrustation ou de compositing. Pour en savoir plus, consultez Présentation du compositing à la page 367. Les clips audio n’affectent jamais la sortie vidéo, 
même s’ils sont placés au-dessus de plans vidéo dans la timeline.
Ajustement du point de connexion d’un plan connecté
Par défaut, les plans et les scénarios connectés sont connectés au scénario principal au niveau 
de leur première image, mais vous pouvez déplacer ce « point de connexion ». Cela s’avère utile 
si vous voulez connecter une image ou un échantillon audio précis du plan ou du scénario 
connecté à une image ou un échantillon audio précis du scénario principal.Chapitre 8 Montage de votre projet 114
m Maintenez les touches Commande et Option enfoncées et cliquez sur le plan connecté (ou sur la 
bordure grise du scénario) à l’endroit où vous voulez placer le point de connexion.
Le point de connexion est positionné à l’endroit où vous avez cliqué.
Point de connexion 
par défaut
Nouvelle position du 
point de connexion
Déplacement, trim ou suppression de plans dans le scénario principal sans affecter les plans 
connectés
Si vous devez déplacer ou effectuer un trim sur des plans dans le scénario principal mais voulez 
conserver l’emplacement des plans connectés, vous pouvez maintenir la touche de l’accent 
grave (`) lors du montage pour préserver la synchronisation et la position des plans connectés.
m Pour déplacer un plan sans affecter pour autant les plans connectés: tout en maintenant enfoncée 
la touche de l’accent grave (`), faites glisser le plan dans la timeline (soit par le biais de l’outil 
Sélection, soit à l’aide de l’outil Position).
Maintenez la touche de l’accent grave (`) 
enfoncée, puis faites glisser le plan.
Le plan connecté conserve 
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m Pour effectue un trim sur un plan sans affecter pour autant les plans connectés: tout en maintenant 
enfoncée la touche de l’accent grave (`), effectuez un trim sur le plan en faisant appel à une 
méthode quelconque, notamment les montages Ripple, les montages Roll, les montages par coulissement et les montages par glissement.
m Pour supprimer un plan sans affecter pour autant les plans connectés: tout en maintenant enfoncée 
la touche de l’accent grave (`), sélectionnez le plan et appuyez sur Supprimer (ou appuyez sur 
Commande +Option + Supprimer).
Pour en savoir plus sur la suppression de plans ou de plages possédant des plans connectés, 
consultez Suppression de plans du projet à la page 122.
m Pour passer à un autre plan dans une audition sans affecter pour autant les plans connectés: tout 
en maintenant enfoncée la touche de l’accent grave (`), sélectionnez la meilleure image dans la 
fenêtre Audition.
Pour en savoir plus, consultez Utilisation d’auditions pour essayer des plans dans votre projet à la 
page 295.
Dans tous ces cas, le ou les plans connectés conservent exactement la même position ainsi que 
leur synchronisation.
Si vous supprimez des plans ou des plages en relation avec des plans connectés et des scénarios 
sans maintenir la touche de l’accent grave (`) enfoncée, des règles particulières s’appliquent alors. 
Pour en savoir plus, consultez Suppression de plans du projet à la page 122.
Écrasement de certaines parties de votre projet
Dans un montage par écrasement, un ou plusieurs plans source écrasent les plans présents dans 
le scénario principal ou un scénario sélectionné, en commençant au point de départ d’une sélection de plage ou au niveau du skimmer ou de la tête de lecture. Puisqu’aucun élément de plan 
ne subit de montage Ripple en avant, la durée de votre projet reste inchangée.
A B C
A D B C
D
Après montage
Avant montage
L’écrasement diffère du remplacement de données. L’écrasement ne fonctionne qu’avec des 
sélections de plage, et non avec des plans complets, et n’est pas limité aux limites des plans. 
Utilisez un montage par écrasement lorsque vous voulez monter une durée de métrage précise 
et non des plans précis.
Remarque : Vous pouvez utiliser un montage à trois points pour réaliser un montage par écrasement. Pour en savoir plus, consultez Présentation du montage à trois points à la page 284.
Écrasement de plans de la timeline par des plans du navigateur d’événements
1 Sélectionnez un ou plusieurs plans dans le navigateur d’événements.
Si la sélection comporte plusieurs plans source, ceux-ci apparaîtront dans la timeline dans l’ordre 
dans lequel ils ont été sélectionnés.
2 Pour définir le point de départ du plan d’écrasement dans la timeline, effectuez l’une des opérations suivantes dans le scénario principal ou un scénario sélectionné :
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• Sélectionnez une plage comprenant un ou plusieurs plans dans la timeline.
Remarque : La commande d’écrasement ignore les sélections de plan complet dans la timeline. 
Si vous ne sélectionnez pas de plage dans la timeline, Final Cut Pro place le point de départ du 
plan d’écrasement au niveau de la tête de lecture ou du skimmer.
3 Choisissez Édition > Écraser (ou appuyez sur la toucheD).
Le plan source apparaît dans le scénario principal et écrase tous les plans existants sur toute 
sa durée. 
Remarque : Si vous utilisez le raccourci clavier et que le skimmer est présent dans la timeline, le 
montage est réalisé au niveau de ce dernier.
Pour réaliser le montage par écrasement en amont de la tête de lecture, de sorte que le point 
d’arrivée du plan d’écrasement (et non son point de départ) soit aligné sur la position cible, 
appuyez sur Maj +D.
Remplacement d’un plan par un autre dans votre projet
Vous pouvez remplacer des plans de votre projet par des plans figurant dans le navigateur d’évé-
nements, d’autres navigateurs multimédias de Final Cut Pro ou le Finder. Contrairement aux montages par écrasement, le remplacement ne fonctionne que sur des plans complets de la timeline 
et peut modifier la durée du projet.
A B C
A D C
D
Après montage
Avant montage
 Les options de remplacement incluent l’utilisation du début ou de la fin du plan source, ainsi 
que la création automatique d’auditions ou l’ajout automatique à des auditions.
Remplacement par glissement d’un plan de la timeline par un ou plusieurs plans
1 Procédez de l’une des manières suivantes pour effectuer une sélection source :
• Sélectionnez un plan ou une plage dans le navigateur d’événements.
• Sélectionnez un élément de média dans l’un des navigateurs multimédias de Final Cut Pro ou 
le Finder.
2 Faites glisser la sélection source sur le plan de la timeline que vous voulez remplacer.
Le plan cible est mis en évidence par un contour blanc dans la timeline.Chapitre 8 Montage de votre projet 117
3 Relâchez le bouton de la souris et choisissez une option dans le menu contextuel :
• Remplacer: Le plan cible est remplacé par la sélection source. La durée est déterminée par 
celle de la sélection source. Si les durées de la sélection source et du plan cible sont diffé-
rentes, les plans suivants sont décalés.
• Remplacer depuis le début: le plan cible est remplacé par la sélection source, en commençant 
au début de celle-ci. La durée est déterminée par celle du plan de la timeline.
• Remplacer depuis la fin : le plan cible est remplacé par la sélection source, en commençant à la 
fin de celle-ci. La durée est déterminée par celle du plan de la timeline.
• Remplacer et ajouter à l’audition : le plan cible est remplacé par une audition dans laquelle la 
sélection source est le meilleur élément et le plan cible un élément alternatif. La durée est 
déterminée par la sélection source. Si les durées de la sélection source et du plan cible sont 
différentes, les plans suivants sont décalés.
• Ajouter à l’audition : le plan cible est remplacé par une audition dans laquelle le plan cible est 
le meilleur élément et la sélection source un élément alternatif.
• Annuler: le montage par remplacement est annulé.
La sélection source apparaît dans la timeline, à la place du plan d’origine.
Le plan source sélectionné 
apparaît dans la timeline.
Remarque : Pour les options « Remplacer depuis le début » et « Remplacer depuis la fin », si 
la sélection source est une sélection de plage ayant une durée inférieure à celle du plan cible 
et qu’il y a suffisamment de données supplémentaires, Final Cut Pro augmente la durée de la 
sélection source pour qu’elle corresponde à celle du plan cible. La durée du scénario obtenu ne 
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Remplacement d’un plan de la timeline à l’aide de raccourcis clavier
1 Dans le navigateur d’événements, sélectionnez le plan ou la plage source.
2 Dans la timeline, sélectionnez le plan à remplacer.
Remarque : Il doit s’agir d’un plan complet, et non d’une plage. Pour en savoir plus, consultez À 
propos des sélections et des pellicules de film à la page 97.
3 Procédez de l’une des manières suivantes:
• Pour réaliser un montage par remplacement standard : appuyez sur Maj + R.
Le plan cible est remplacé par la sélection source. La durée est déterminée par celle de la 
sélection source. Si les durées de la sélection source et du plan cible sont différentes, les plans 
suivants sont décalés.
• Pour réaliser un montage Remplacer depuis le début: appuyez sur Option + R.
Le plan cible est remplacé par le plan source, en commençant au début de celui-ci. La durée 
est déterminée par celle du plan de la timeline.
Remarque : Pour l’option « Remplacer depuis le début », si la sélection source est une sélection de plage ayant une durée inférieure à celle du plan cible et qu’il y a suffisamment de 
données supplémentaires, Final Cut Pro augmente la durée de la sélection source pour qu’elle 
corresponde à celle du plan cible. La durée du scénario obtenu ne change pas.
La sélection source apparaît dans la timeline, à la place du plan d’origine.
Ajout et montage d’images fixes
Dans Final Cut Pro, vous pouvez ajouter et monter de nombreux formats d’image fixe dans vos 
projets, notamment des photos et des fichiers graphiques.
Ajout d’une image fixe à la timeline
Vous pouvez ajouter des images fixes à votre projet depuis le navigateur d’événements ou le 
navigateur de photos.
m Pour ajouter une image fixe depuis le navigateur d’événements: importez l’image fixe dans un évé-
nement, puis sélectionnez intégralement ou partiellement le plan d’image fixe et faites-le glisser 
du navigateur d’événements vers la timeline.
Remarque : Lorsqu’une image fixe est importée, elle fonctionne comme tout autre plan dans 
Final Cut Pro. Vous pouvez utiliser toutes les techniques décrites dans le présent chapitre pour 
ajouter des plans d’image fixe à la timeline.
m Pour ajouter une image fixe depuis le navigateur de photos: ouvrez le navigateur de photos, sélectionnez une image fixe, puis faites-la glisser directement vers la timeline.
La durée initiale par défaut des sélections de plage dans les images fixes est de 4 secondes, mais 
vous pouvez la modifier dans la fenêtre Montage des préférences de Final Cut Pro.
La durée d’un plan d’image fixe n’est pas limitée. Pour modifier la durée d’un plan d’image fixe 
dans la timeline, utilisez l’une des techniques de trim décrites dans le présent chapitre. Pour 
modifier la durée de plusieurs plans d’image fixe en même temps, sélectionnez ces derniers et 
choisissez Modifier > Modifier la durée (ou appuyez sur Contrôle +D).Chapitre 8 Montage de votre projet 119
Ajout de fichiers graphiques multicouche à la timeline
Il vous est possible d’ajouter des fichiers graphiques multicouches, tels que les fichiers Adobe 
Photoshop (PSD), créés dans une autre application de retouche d’image à la timeline.
1 Importez le fichier graphique multicouche dans un événement.
Important : si le fichier graphique multicouche présente un arrière-plan transparent, assurezvous que le format de rendu de votre projet est défini sur Apple ProRes 4444 afin de préserver 
la transparence au moment du rendu. Consultez Modification du nom et des propriétés d’un 
projet à la page 89.
2 Dans le navigateur d’événements, maintenez la touche Contrôle enfoncée et cliquez sur l’image 
multicouche, puis choisissez «Ouvrir dans la timeline » dans le menu contextuel.
Chaque couche s’affiche sur la timeline sous forme de plan connecté qu’il vous est possible 
de monter comme vous le feriez pour tout autre plan. Par exemple, vous pouvez animer des 
couches en leur appliquant un fondu entrant ou sortant.
Image de graphiques en couches dans le visualiseur
Plan représentant des couches individuelles
La durée par défaut d’un fichier graphique multicouche est d’une minute. Pour modifier la durée 
d’une des couches dans la timeline, utilisez l’une des techniques de trim décrites dans le présent 
chapitre. Pour modifier la durée de toutes les couches, sélectionnez ces derniers et choisissez 
Modifier > Modifier la durée (ou appuyez sur Contrôle +D).
Pour en savoir plus sur la création de fichiers graphiques multicouches pour Final Cut Pro, consultez la page http://support.apple.com/kb/HT5152?viewlocale=fr_FR.
Modification d’une image fixe avec une application d’édition d’image externe
Vous pouvez modifier une image fixe à l’aide d’une application d’édition d’image externe ; les 
modifications apparaissent automatiquement dans le plan dans Final Cut Pro. 
1 Pour ajouter un plan d’image fixe à la timeline, procédez comme indiqué ci-dessus.
2 Pour retrouver le fichier de média source du plan dans le Finder, appuyez sur 
Commande + Maj + R. 
3 Ouvrez le fichier multimédia source dans l’application d’édition d’image externe.
4 Modifiez l’image dans l’application d’édition d’image et enregistrez les modifications.Chapitre 8 Montage de votre projet 120
5 Retournez dans Final Cut Pro.
Les modifications apparaissent automatiquement dans le plan d’image fixe dans Final Cut Pro.
Vous pouvez également créer des images figées à partir de vos plans vidéo. Pour en savoir plus, 
consultez Création d’images figées à la page 120.
Création d’images figées
Vous pouvez créer en toute simplicité des plans d’arrêt sur image à partir de n’importe quel plan 
vidéo. Les plans d’arrêt sur image contiennent une image particulière permettant d’interrompre 
temporairement l’action à l’écran.
Vous pouvez créer des plans d’arrêt sur image à partir de plans dans la timeline ou le navigateur 
d’événements. Si vous créez un plan d’arrêt sur image à partir du navigateur d’événements, il est 
alors attaché au scénario principal au niveau de la tête de lecture sous forme de plan connecté.
Vous pouvez créer des images figées à la volée pendant la lecture ou en accédant à une image 
donnée dans un plan.
Remarque : Un plan d’arrêt sur image conserve tous les attributs appliqués au plan source, par 
exemple les réglages et les effets.
Création d’un plan d’arrêt sur image
1 Dans la timeline ou le navigateur d’événements, procédez de l’une des façons suivantes:
• Placez le skimmer ou la tête de lecture sur l’image à figer.
• Lancez la lecture du plan.
2 Choisissez Édition > Ajouter un arrêt sur image (ou appuyez simultanément sur les touches 
Option + F).
Le mode d’ajout de l’arrêt sur image au projet dépend de l’emplacement où l’image a été créée : 
depuis la timeline ou du navigateur d’événements.
• Si vous avez créé l’image figée à partir d’un plan dans la timeline : un nouveau plan d’arrêt sur 
image est inséré dans la timeline à l’emplacement du skimmer ou de la tête de lecture.
• Si vous avez créé l’image figée à partir d’un plan dans le navigateur d’événements: un nouveau 
plan d’arrêt sur image est joint sous forme de plan connecté dans la timeline à l’emplacement 
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Modification de la durée par défaut des plans d’arrêt sur image
Les plans d’arrêt sur image possèdent la même durée par défaut que les plans d’images 
fixes, à savoir 4 secondes. Vous pouvez modifier la durée par défaut dans les préférences de 
Final Cut Pro.
1 Choisissez Final Cut Pro > Préférences (ou appuyez sur Commande + virgule), puis cliquez sur le 
bouton Montage en haut de la fenêtre.
2 Réglez la case de valeur Images fixes.
Si vous ne voulez pas créer de plan à part pour les images figées, vous pouvez créer un segment 
de suspension à l’aide du menu local Resynchronisation. Pour en savoir plus, consultez Création 
d’un segment de suspension à la page 305.
Ajout de plans en mode vidéo uniquement ou audio uniquement
Par défaut, lorsque vous ajoutez un plan d’un événement à la timeline, tous les composants 
vidéo et audio de ce plan sont inclus dans le montage. Toutefois, vous pouvez également 
n’ajouter que la partie vidéo ou la partie audio des plans d’événement à la timeline, même s’ils 
contiennent de la vidéo et de l’audio.
Réalisation de montages Vidéo seulement ou Audio seulement
1 Pour définir le mode de montage, effectuez l’une des opérations suivantes:
• Pour n’ajouter que la vidéo de votre sélection à la timeline : choisissez Vidéo seulement dans le 
menu local Édition de la barre d’outils (ou appuyez sur Maj + 2). 
• Pour n’ajouter que l’audio de votre sélection à la timeline : choisissez Audio seulement dans le 
menu local Édition de la barre d’outils (ou appuyez sur Maj + 3). 
Les boutons de montage de la barre d’outils changent d’aspect pour indiquer le mode 
sélectionné :
Mode Vidéo 
uniquement
Mode Audio 
uniquement
2 Ajoutez des plans à la timeline comme vous le faites habituellement.
Le plan Vidéo seulement ou Audio seulement apparaît dans la timeline.
Pour revenir au mode par défaut (vidéo et audio), dans le menu local Édition de la barre d’outils 
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Suppression de plans du projet
Lorsque vous supprimez des plans d’un projet dans la timeline, les données source figurant dans 
les événements, les navigateurs multimédias de Final Cut Pro et le Finder ne sont pas affectées.
Suppression de plans ou de plages de la timeline
1 Sélectionnez dans la timeline les plans ou la plage à supprimer. 
2 Choisissez Édition > Supprimer (ou appuyez sur la touche Supprimer).
Les plans ou parties de plans sélectionnés sont supprimés de la timeline, et les plans situés à 
droite de la sélection (le cas échéant) sont décalés pour combler le vide résultant.
Pour annuler immédiatement la suppression, choisissez Édition > Annuler (ou appuyez sur 
Commande + Z).
Remarque : En général, si vous sélectionnez un plan complet de la timeline (par exemple, avec 
la touche C) ou une plage se composant d’un plan complet (par exemple, avec la touche X) et 
que vous supprimez cette sélection, les éventuels plans connectés ou scénarios sont également 
supprimés. Cependant, il est possible de supprimer un plan sans affecter pour autant ses plans 
connectés en maintenant enfoncée la touche de l’accent grave (`) tout en appuyant sur la touche 
Supprimer. Pour en savoir plus, consultez «Déplacement, trim ou suppression de plans dans le 
scénario principal sans affecter les plans connectés » dans Connexion de plans pour ajouter des 
prises, des titres et des effets de son synchronisés à la page 110. En outre, si vous supprimez une 
plage partielle d’un plan, qui inclut un plan ou un scénario connecté, les éléments de ce type ne 
sont alors pas supprimés mais décalés au plan le plus proche dans le scénario principal.
Suppression de plans ou de plages sans affecter la durée totale et la synchronisation 
du projet
Si vous souhaitez supprimer des plans de la timeline tout en préservant la durée totale et la 
synchronisation du projet, vous pouvez remplacer ces plans par des plans vides. Cette méthode 
évite les montages Ripple.
1 Sélectionnez les plans ou la plage à supprimer.
2 Choisissez Édition > Remplacer par un blanc (ou appuyez sur Maj + Supprimer).
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Remarque : Cette méthode préserve les plans connectés. Lorsque vous remplacez un plan par un 
plan vide, les éventuels plans connectés sont associés à ce dernier.
Isolement, désactivation et activation de plans
Il peut parfois être utile de lire une séquence avec et sans certains plans à des fins de comparaison. Dans Final Cut Pro, vous pouvez rapidement lire l’audio d’un plan excluant ainsi l’audio des 
autres plans. Cette fonctionnalité, appelée solo, désactive l’audio de tous les plans non sélectionnés dans la timeline. Vous pouvez également désactiver (et non supprimer) des plans sélectionnés, ce qui a pour effet de les rendre invisibles et inaudibles lors de la lecture. Les plans désactivés n’apparaissent dans aucune sortie. Vous pouvez les réactiver tout aussi facilement.
Isolement d’éléments sélectionnés
Si vous voulez vous concentrer sur un sous-ensemble de plans dans la timeline, vous pouvez 
sélectionner ces derniers et les isoler des autres.
1 Dans la timeline, sélectionnez les plans à isoler.
2 Procédez de l’une des manières suivantes:
• choisissez Plan > Solo (ou appuyez sur les touches Option + S).
• Cliquez sur le bouton Solo dans le coin supérieur droit de la timeline.
Lorsque l’isolement est activé, le bouton Solo est jaune et les plans non sélectionnés sont affichés en noir et blanc, ce qui permet d’identifier facilement les plans isolés, qui sont entourés 
en jaune.
3 Pour désactiver l’isolement, cliquez à nouveau sur le bouton Solo.
Désactivation et réactivation d’un ou de plusieurs plans
1 Sélectionnez un ou plusieurs plans dans la timeline.
2 Choisissez Plan > Désactiver (ou appuyez sur la touche V).
Les plans désactivés sont estompés dans la timeline et sont invisibles et inaudibles pendant 
la lecture.
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3 Pour réactiver les clips désactivés, sélectionnez-les dans la timeline et choisissez Plan > 
Désactiver (ou appuyez sur la touche V).
Recherche d’un plan source d’un plan de la timeline
Vous pouvez rechercher rapidement le plan d’événement source d’un plan que vous utilisez 
dans la timeline de votre projet. Cela s’avère particulièrement utile si vous voulez dupliquer un 
plan de votre projet ou ajouter le même plan à un autre projet.
Recherche et affichage du plan d’événement source d’un plan de la timeline
1 Dans la timeline, sélectionnez le plan dont vous voulez localiser le plan d’événement source.
2 Procédez de l’une des manières suivantes:
• Choisissez Plan > Afficher dans le navigateur d’événements (ou appuyez sur Maj + F).
• Cliquez sur le plan tout en maintenant la touche Contrôle enfoncée, puis choisissez « Afficher 
dans le navigateur d’événements » dans le menu contextuel.
Une bordure de sélection apparaît autour du plan source dans le navigateur d’événements et la 
position de la tête de lecture dans le plan source correspond à celle de la tête de lecture dans le 
plan de la timeline.
Disposition des plans dans la timeline
Dans Final Cut Pro, vous pouvez organiser et réorganiser les plans de votre projet comme vous le 
souhaitez. Si vous ajoutez ou déplacez un plan dans la timeline en le faisant glisser, Final Cut Pro 
déplace les autres plans pour lui faire de la place. Vous pouvez également déplacer les plans 
numériquement en saisissant une valeur de timecode, les déplacer légèrement à l’aide de raccourcis clavier, les écraser à l’aide de l’outil Position et les déplacer verticalement depuis et vers le 
scénario principal.
Déplacement de plans par glissement horizontal
m Dans la timeline, sélectionnez un ou plusieurs plans et faites-les glisser vers un nouvel emplacement du projet. 
Pendant que vous faites glisser les plans, un contour de la sélection apparaît au nouvel emplacement de la timeline. Lorsque vous relâchez le bouton de la souris, le ou les plans repositionnés apparaissent au nouvel emplacement. Final Cut Pro décale les plans (et les éventuels plans 
connectés) dans la timeline pour faire de la place aux plans repositionnés et pour combler le 
vide laissé par ces derniers. Vous pouvez également faire glisser les plans verticalement vers et 
depuis le scénario principal.
Remarque : Cette méthode de déplacement horizontal des plans est l’équivalent fonctionnel du 
montage par déplacement disponible dans Final Cut Pro 7, en plus simple.Chapitre 8 Montage de votre projet 125
Déplacement de plans à l’aide d’une valeur de timecode
Vous pouvez déplacer des plans sélectionnés dans la timeline en saisissant la durée dont vous 
souhaitez les décaler.
1 Sélectionnez un ou plusieurs plans dans la timeline.
2 Effectuez l’une des opérations suivantes, ou les deux :
• Pour déplacer les plans vers l’avant: appuyez sur la touche Plus(+), puis entrez une durée de 
timecode pour le déplacement.
• Pour déplacer les plans vers l’arrière : appuyez sur la touche Tiret (-), puis entrez une durée de 
timecode pour le déplacement.
Remarque : Pour en savoir plus et obtenir des conseils pour la saisie des valeurs de timecode, 
consultez la section Navigation à l’aide du timecode à la page 151.
Le champ de saisie du timecode (avec des nombres bleus) apparaît dans le panneau de contrôle 
de la barre d’outils pendant que vous tapez.
Champ de saisie du timecode 
dans le Dashboard
3 Appuyez sur la touche Entrée.
Les plans sont déplacés vers l’avant ou l’arrière de la durée saisie et écrasent les plans présents 
au nouvel emplacement, le cas échéant. Si les plans sélectionnés se trouvent dans un scénario, 
un plan vide comble les parties vacantes de ce dernier.
Le plan se déplace vers 
l’avant ou l’arrière de la 
durée saisie.
Un plan vide comble 
la partie vacante du 
scénario.
Déplacement léger de plans à l’aide de raccourcis clavier
La fonctionnalité de déplacement léger dans Final Cut Pro vous permet de déplacer très légèrement les éléments sélectionnés, par exemple de quelques images ou sous-images (pour les plans 
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1 Sélectionnez un ou plusieurs plans dans la timeline.
2 Pour déplacer légèrement les plans, effectuez l’une des opérations suivantes:
• Pour déplacer la sélection d’une image vers la gauche : appuyez sur la touche Virgule (,).
• Pour déplacer la sélection de 10 images vers la gauche : appuyez sur Maj +Virgule (,).
• Pour déplacer la sélection d’une image vers la droite : appuyez sur la touche Point (.).
• Pour déplacer la sélection de 10 images vers la droite : appuyez sur Maj + point (.).
3 Si vous souhaitez déplacer légèrement des clips audio connectés d’une ou de plusieurs sousimages, effectuez l’une des opérations suivantes:
• Pour déplacer la sélection d’une sous-image vers la gauche : appuyez sur Option +Virgule (,).
• Pour déplacer la sélection de 10 sous-images vers la gauche : appuyez sur 
Maj +Option +Virgule (,).
• Pour déplacer la sélection d’une sous-image vers la droite : appuyez sur Option + point (.).
• Pour déplacer la sélection de 10 sous-images vers la droite : appuyez sur Maj +Option + point (.).
Pour en savoir plus sur les sous-images, consultez la section Affichage des formes d’onde audio 
au niveau de l’échantillon audio à la page 169.
Les plans déplacés écrasent les plans présents au nouvel emplacement, le cas échéant. Un plan 
vide comble les parties vacantes de la timeline.
Écrasement de plans à l’aide de l’outil Position
Vous pouvez déplacer des plans en les faisant glisser dans la timeline pour écraser d’autres plans. 
Cela vous permet de positionner précisément des plans sans provoquer le déplacement d’autres 
plans pour faire de la place.
1 Choisissez l’outil Position dans le menu local Outils de la barre d’outils (ou appuyez sur la 
touche P).
Le pointeur prend la forme de l’outil Position .
Conseil : Vous pouvez activer temporairement l’outil Position en maintenant la touche P enfoncée. Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.Chapitre 8 Montage de votre projet 127
2 Sélectionnez le plan à déplacer.
3 Faites glisser le plan vers un nouvel emplacement de la timeline.
Le plan déplacé écrase les plans présents au nouvel emplacement, le cas échéant. Un plan vide 
comble la partie vacante de la timeline.
Remarque : Si vous préférez déplacer les plans vers la gauche ou la droite dans la timeline sans 
laisser de blanc, vous pouvez réaliser un montage par coulissement. 
Pour revenir à l’outil Sélectionner (outil par défaut), choisissez-le dans le menu local Outils de la 
barre d’outils (ou appuyez sur la touche A).
Glissement de plans depuis et vers le scénario principal
Vous pouvez faire glisser des plans depuis et vers le scénario principal. Cette technique fait appel 
aux montages Ripple, qui ont une incidence sur la durée totale de votre projet. Lorsque vous 
déplacez un plan hors du scénario principal, il devient soit un plan connecté individuel, soit un élé-
ment d’un scénario connecté.
1 Si l’outil Sélectionner n’est pas actif, choisissez-le dans le menu local Outils de la barre d’outils (ou 
appuyez sur la touche A).
2 Sélectionnez un ou plusieurs plans (plans du scénario principal ou plans connectés).
3 Effectuez l’une des opérations suivantes:
• Pour déplacer les plans hors du scénario principal : faites glisser les plans du scénario principal vers 
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Les plans suivants dans le scénario principal sont décalés vers la gauche pour combler le vide 
laissé par les plans que vous avez déplacés.
Faites glisser le plan sur 
sa nouvelle position en 
tant que plan connecté.
Les plans suivants sont 
raccordés à gauche pour 
combler le vide.
• Pour déplacer les plans vers le scénario principal : faites glisser les plans de leur emplacement de 
plans connectés vers un point de montage (entre deux plans) du scénario principal. 
Ce faisant, vous réalisez en fait un montage par insertion : les anciens plans connectés sont insérés 
dans le scénario principal et les plans suivants sont décalés vers la droite pour leur faire de la place.
Remarque : Vous pouvez faire glisser des plans depuis et vers le scénario principal à condition qu’aucun plan ne soit connecté à ces derniers. Si un plan est connecté, vous devez d’abord le déplacer ou 
le supprimer, ou vous devez utiliser la commande « Prélever du scénario principal » ou « Remplacer 
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Déplacement de plans depuis et vers le scénario principal sans montage Ripple du projet
Vous pouvez déplacer des plans depuis et vers le scénario principal sans affecter la durée totale 
de votre projet.
1 Sélectionnez les plans à déplacer.
2 Effectuez l’une des opérations suivantes:
• Pour déplacer les plans sélectionnés du scénario principal vers des plans connectés au même 
emplacement de la timeline : choisissez Édition > Prélever du scénario principal (ou appuyez sur 
Commande +Option + flèche vers le haut). 
Nouveau plan connecté à la 
même position dans la timeline
Un plan vide comble la partie 
vacante du scénario principal.
Des plans vides comblent les parties vacantes du scénario principal, si nécessaire. 
• Pour déplacer les plans connectés sélectionnés vers le scénario principal : choisissez Édition > 
Remplacer par le scénario principal (ou appuyez sur Commande +Option + Flèche vers 
le bas). 
Selon le niveau de chevauchement sur le plan connecté, la commande « Remplacer par le 
scénario principal » crée un montage scindé ou écrase les plans vidéo présents au nouvel 
emplacement et convertit la partie audio du plan écrasé en plan connecté. La commande 
« Remplacer par le scénario principal » n’est pas disponible pour les plans Audio seulement.
Remarque : La commande « Remplacer par le scénario principal » ne fonctionne qu’avec des 
plans connectés individuels. Pour l’utiliser sur un plan figurant dans un scénario connecté, 
déplacez d’abord ce plan hors du scénario. 
Vous pouvez obtenir les mêmes résultats en faisant glisser les plans à l’aide de l’outil Position.Chapitre 8 Montage de votre projet 130
Coupe et trim des plans
Présentation du trim
Après avoir grossièrement assemblé vos plans dans l’ordre chronologique dans la timeline, vous 
pouvez commencer à ajuster le point de montage entre chaque paire de plans contigus. Toute 
opération de rallongement ou de raccourcissement d’un plan dans un projet représente une 
opération de trim sur le plan en question. Ceci étant dit, le trim constitue généralement un ajustement précis (qui s’applique aussi bien à une image qu’à plusieurs secondes du plan). Si vous 
modifiez la durée d’un plan en manipulant des durées plus longues, il s’agit toujours d’opérations de trim, bien que cela ne s’inscrive pas encore dans la phase d’affinement du montage.
Dans Final Cut Pro, vous pouvez utiliser de nombreuses techniques pour appliquer un trim aux 
plans et aux points de montage dans la timeline, notamment les montages Ripple, Roll, par coulissement et par glissement.
Indépendamment de la façon dont vous réalisez le trim ou autres montages dans Final Cut Pro, 
le média sous-jacent n’est jamais modifié. Les parties des plans effacées ou ayant fait l’objet d’un 
trim ne sont supprimées que du projet, et non des plans source présents dans votre bibliothèque 
d’événements ni des fichiers multimédias source stockés sur votre disque dur.
Conseil : Un « double » affichage apparaît dans le visualiseur lorsque vous appliquez un trim 
à des points de montage dans la timeline. Pour en savoir plus, consultez Affichage détaillé des 
commentaires sur le trimming à la page 145.
Coupe de plans à l’aide de l’outil Lame de rasoir
Après avoir ajouté des plans à la timeline, vous pouvez facilement les couper pour ajuster leur 
durée ou supprimer les parties dont vous ne voulez pas.
Le montage le plus élémentaire est la coupe droite. À l’origine, il s’agit d’une opération de montage de film consistant à couper une pellicule à l’aide d’un rasoir et à coller un nouveau « plan ».
Lorsque vous coupez un plan dans votre projet, il est divisé en deux. Vous pouvez couper un ou 
plusieurs plans à la fois. 
Coupe d’un plan dans la timeline
1 Choisissez l’outil Lame de rasoir dans le menu local Outils de la barre d’outils (ou appuyez sur la 
touche B).
Le pointeur prend la forme de l’outil Lame de rasoir .
Conseil : Vous pouvez activer temporairement l’outil Lame de rasoir en maintenant la touche B 
enfoncée. Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.Chapitre 8 Montage de votre projet 131
2 Placez le skimmer sur l’image du plan où vous souhaitez effectuer la coupe, puis cliquez.
Outil Lame de rasoir
Conseil : Vous pouvez également couper des plans pendant la lecture de votre projet. Pour 
couper des plans à la volée, appuyez sur les touches Commande + B à tout moment pendant la 
lecture de votre projet.
Un point de montage apparaît à l’endroit où vous avez cliqué et le plan est divisé en deux.
Nouveau point de montage
Coupe de tous les plans à la fois
La commande « Lame de rasoir sur tout » vous permet de couper simultanément tous les plans 
du scénario principal et les plans connectés situés au niveau du skimmer ou de la tête de lecture.
1 Dans la timeline, placez le skimmer sur l’image où vous souhaitez effectuer la coupe.
2 Choisissez Édition > Lame de rasoir sur tout (ou appuyez sur les touches Commande + Maj + B).
Tous les plans au niveau du skimmer sont alors coupés.
Coupe de plusieurs plans sélectionnés à la fois
Vous pouvez utiliser la commande Lame de rasoir pour couper simultanément des plans sélectionnés du scénario principal et des plans connectés.
1 Dans la timeline, sélectionnez les plans à couper.Chapitre 8 Montage de votre projet 132
2 Placez le skimmer sur l’image où vous souhaitez effectuer la coupe.
3 Choisissez Édition > Lame de rasoir (ou appuyez sur Commande + B).
Les plans sélectionnés sont coupés au niveau du skimmer.
Remarque : Si aucun élément n’est sélectionné, cette commande ne s’applique qu’au plan du 
scénario principal.
Extension ou raccourcissement d’un plan
Vous pouvez appliquer un trim à un plan de votre projet en ajustant le point de départ ou d’arrivée de ce plan. 
Le type de trim par défaut dans Final Cut Pro, le trim Ripple, règle le point de départ ou le point 
d’arrivée d’un plan sans laisser de vide dans la timeline. La modification de la durée du plan est 
propagée vers l’extérieur, avançant ou reculant tous les plans suivants dans la timeline. 
A B C
A B C
Avant montage
Après montage
De même, si vous supprimez un plan de la timeline, les plans suivants s’adaptent en amont pour 
fermer le vide. Les montages Ripple affectent le plan auquel le trim est appliqué, la position de 
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Un « double » affichage apparaît dans le visualiseur lorsque vous appliquez un trim à des points 
de montage dans la timeline. Cet affichage présente en détail les parties situées de part et 
d’autre du point de montage. Pour en savoir plus, consultez Affichage détaillé des commentaires 
sur le trimming à la page 145.
Glissement de points de montage à l’aide de l’outil Sélectionner
1 Dans la timeline, placez le pointeur sur le point de départ ou d’arrivée du plan auquel vous 
voulez appliquer un trim.
La forme du pointeur passe d’une icône de flèche à une icône de trim. L’apparence de l’icône 
de trim change pour indiquer si le trim va modifier le point d’arrivée du plan de gauche ou le 
point de départ du plan de droite.
Trim du point de sortie 
du plan de gauche.
Trim du point d’entrée 
du plan de droite.
2 Faites glisser le point de départ ou d’arrivée dans la direction dans laquelle vous voulez appliquer le trim au plan.
Le plan est raccourci ou allongé à mesure que vous faites glisser le point. Le contenu des champs 
de timecode numérique indique la durée du plan et la quantité de temps correspondant au 
déplacement du point de montage.
Les plans situés à droite du point de montage, le cas échéant, sont décalés en conséquence. 
Une fois que vous avez atteint la longueur maximale du plan dans l’une ou l’autre direction, le 
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Modification de la durée d’un plan à l’aide d’une valeur de timecode
Vous pouvez modifier la durée totale d’un ou de plusieurs plans sélectionnés en saisissant une 
valeur de timecode. 
1 Sélectionnez un ou plusieurs plans dans la timeline.
2 Procédez de l’une des manières suivantes:
• Choisissez Modifier > Modifier la durée (ou appuyez sur Contrôle +D).
• Double-cliquez au centre du panneau de contrôle de la barre d’outils. 
Le champ de saisie du timecode apparaît dans le panneau de contrôle.
3 Saisissez une nouvelle durée pour le plan sélectionné.
Final Cut Pro déplace le point d’arrivée du plan en fonction de la durée saisie et décale en consé-
quence les plans suivants dans la timeline. 
Pour en savoir plus sur la saisie de valeurs de timecode, consultez la section Navigation à l’aide 
du timecode à la page 151.
Remarque : Si vous saisissez une durée supérieure aux données disponibles dans le plan, 
Final Cut Pro prolonge ce dernier jusqu’à sa durée maximale.
Trim d’une sélection
1 Dans la timeline, sélectionnez la partie d’un plan que vous voulez conserver.
Plan d’origine
Sélection de plage
Pour en savoir plus sur les sélections de plage, consultez Sélection d’une plage à la page 100.
2 Choisissez Édition > Ajuster à la sélection.
Final Cut Pro applique un trim aux points de départ et d’arrivée du plan pour l’ajuster à la 
plage sélectionnée.
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Les parties dont vous ne voulez pas sont supprimées du plan et du projet, et les plans suivants 
dans le projet sont décalés en conséquence.
Déplacement léger de points de montage à l’aide de raccourcis clavier
Vous pouvez ajuster avec précision le point de départ ou d’arrivée d’un plan à l’aide de raccourcis clavier. Vous pouvez déplacer le point de montage d’une ou de plusieurs images vidéo, et 
vous pouvez également déplacer les points de montage de clips audio connectés (c’est-à-dire ne 
figurant pas dans le scénario principal) d’une ou de plusieurs sous-images.
1 Dans la timeline, sélectionnez le point de départ ou d’arrivée du plan auquel vous voulez appliquer un trim.
2 Pour déplacer le point de montage, effectuez l’une des opérations suivantes:
• Pour déplacer le point de montage d’une image vers la gauche : appuyez sur la touche Virgule (,).
• Pour déplacer le point de montage de 10 images vers la gauche : appuyez sur Maj +Virgule (,).
• Pour déplacer le point de montage d’une image vers la droite : appuyez sur la touche Point (.).
• Pour déplacer le point de montage de 10 images vers la droite : appuyez sur Maj + point (.).
3 Si vous souhaitez déplacer le point de montage de clips audio connectés d’une ou de plusieurs 
sous-images, effectuez l’une des opérations suivantes:
• Pour déplacer le point de montage d’une sous-image vers la gauche : appuyez sur 
Option +Virgule (,).
• Pour déplacer le point de montage de 10 sous-images vers la gauche : appuyez sur 
Maj +Option +Virgule (,).
• Pour déplacer le point de montage d’une sous-image vers la droite : appuyez sur 
Option + point (.).
• Pour déplacer le point de montage de 10 sous-images vers la droite : appuyez sur 
Maj +Option + point (.).
Pour en savoir plus sur les sous-images, consultez la section Affichage des formes d’onde audio 
au niveau de l’échantillon audio à la page 169.
Le plan est ajusté et la timeline est actualisée en conséquence.
Déplacement de points de montage vers la tête de lecture
Vous pouvez ajuster des points de montage sélectionnés dans la timeline en procédant à un 
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1 Dans la timeline, sélectionnez le point de montage à ajuster.
Point de sortie sélectionné
Remarque : Pour un montage Roll, sélectionnez les deux côtés du point de montage à l’aide de 
l’outil Trim.
2 Placez la tête de lecture ou le skimmer à l’endroit de la timeline vers lequel vous voulez déplacer 
le point de montage.
Skimmer
3 Choisissez Édition > Étendre le montage (ou appuyez sur Maj + X).
Le point de montage est déplacé (en avant ou en arrière) vers la tête de lecture ou le skimmer.
Le point de sortie du plan est 
positionné à l’emplacement du 
skimmer et les plans suivants sont 
Dans l’exemple ci-dessus, si vous avez sélectionné le point d’arrivée du plan, les plans suivants 
dans la timeline sont décalés en conséquence. Si vous avez sélectionné les deux côtés du point 
de montage à l’aide de l’outil Trim, le plan de droite est raccourci (par le biais d’un montage Roll) 
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Trim de points de montage à l’aide de valeurs de timecode
Vous pouvez appliquer des trims aux plans à l’aide de valeurs de timecode.
1 Si l’outil Sélectionner n’est pas actif, choisissez-le dans le menu local Outils de la barre d’outils 
(ou appuyez sur la touche A).
2 Dans la timeline, sélectionnez le point de départ ou d’arrivée du plan auquel vous voulez appliquer un trim.
3 Pour appliquer un trim au point de montage, effectuez l’une des opérations suivantes:
• Pour déplacer le point de montage vers l’avant: appuyez sur la touche Plus(+), entrez une durée 
de timecode pour le trim, puis appuyez sur Entrée.
• Pour déplacer le point de montage vers l’arrière : appuyez sur la touche Signe moins (-), entrez 
une durée de timecode pour le trim, puis appuyez sur Entrée.
Le champ de saisie du timecode (avec des nombres bleus et le signe plus ou moins) apparaît 
dans le panneau de contrôle de la barre d’outils pendant que vous tapez.
Champ de saisie 
du timecode
Le plan est raccourci ou étendu de la durée saisie et tous les plans suivants dans la timeline sont 
décalés en conséquence.
Remarque : Cette fonctionnalité ne permet pas d’étendre un plan au-delà de sa durée maximale.
Pour en savoir plus et obtenir des conseils pour la saisie des valeurs de timecode, consultez la 
section Navigation à l’aide du timecode à la page 151.Chapitre 8 Montage de votre projet 138
Coupe du début ou de la fin d’un plan au niveau de la tête de lecture
Il se peut que certains de vos plans vidéo présentent au début ou à la fin des sections que vous 
ne voulez pas inclure dans votre projet. Vous pouvez facilement couper ces plages à l’aide d’une 
seule commande, même pendant la lecture du projet. Aucune sélection n’est requise. Ce type de 
montage est parfois appelé éboutage.
1 Dans la timeline, placez la tête de lecture ou le skimmer sur l’image au niveau de laquelle vous 
voulez ébouter le plan.
Skimmer
Plan d’origine
2 Procédez de l’une des manières suivantes:
• Pour couper le début du plan : choisissez Édition > Trim sur le début, ou appuyez sur 
Option + crochet gauche ([).
• Pour couper la fin du plan : choisissez Édition > Trim sur la fin, ou appuyez sur Option + crochet 
droit (]).
Le plan est ébouté au niveau de la tête de lecture (ou du skimmer) et la timeline est actualisée 
en conséquence.
Nouveau point de sortie 
du plan après Trim
Plan après Trim
Dans le cas des plans ou des scénarios connectés, Final Cut Pro applique le trim au plan sélectionné. Si aucun plan n’est sélectionné, Final Cut Pro applique le trim au plan de dessus.
Réalisation de montages Roll à l’aide de l’outil Trim
Un montage Roll consiste à ajuster simultanément les points de départ et d’arrivée de deux 
plans adjacents. Si vous aimez la façon dont sont disposés deux plans dans la timeline mais que 
vous souhaitez repositionner le point de coupe, vous pouvez utiliser l’outil Trim pour déplacer 
le point de montage entre les deux plans. Cela n’entraîne pas le déplacement des plans dans la 
timeline. Seul le point de montage entre les deux plans change de place. Aucun autre plan du 
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Lorsque vous procédez à un montage Roll, la durée totale du projet reste la même, mais celle des 
deux plans change. L’un s’allonge alors que l’autre rétrécit en compensation.
A B C
A B C
Avant montage
Après montage
Dans l’exemple ci-dessus, le plan B raccourcit tandis que le plan C s’allonge. En revanche, la durée 
combinée des deux plans reste la même.
Un « double » affichage apparaît dans le visualiseur lorsque vous appliquez un trim à des points 
de montage dans la timeline. Cet affichage présente en détail les parties situées de part et 
d’autre du point de montage. Pour en savoir plus, consultez Affichage détaillé des commentaires 
sur le trimming à la page 145.
Roll d’un point de montage
1 Choisissez l’outil Trim dans le menu local Outils de la barre d’outils (ou appuyez sur la touche T).
Le pointeur prend la forme de l’outil Trim .
Conseil : Vous pouvez activer temporairement l’outil Trim en maintenant la touche T enfoncée. 
Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.
2 Dans la timeline, cliquez au centre du point de montage que vous voulez déplacer de sorte que 
ses deux côtés soient sélectionnés.
3 Procédez de l’une des manières suivantes:
• Faites glisser le point de montage vers la gauche ou vers la droite.
• Appuyez sur la touche Plus(+) ou Moins(–), saisissez la durée de timecode à ajouter ou à 
soustraire du montage actuel, puis appuyez sur Entrée.Chapitre 8 Montage de votre projet 140
Le champ de saisie du timecode (avec des nombres bleus) apparaît dans le panneau de 
contrôle de la barre d’outils pendant que vous tapez.
Pour en savoir plus sur la saisie de valeurs de timecode, consultez la section Navigation à l’aide 
du timecode à la page 151. 
• Placez la tête de lecture ou le skimmer à l’endroit de la timeline vers lequel vous voulez déplacer le point de montage, puis choisissez Édition > Étendre le montage (ou appuyez sur Maj + X).
Le point de montage est déplacé vers le nouvel emplacement. La durée globale des deux plans 
reste la même.
Si vous ne parvenez pas à déplacer davantage le point de montage et qu’un côté de celui-ci apparaît en rouge, cela signifie que vous avez atteint la fin des données de l’un des deux plans.
Réalisation de montages par coulissage à l’aide de l’outil Trim
Un montage par coulissement ne modifie pas la position ou la durée d’un plan dans la timeline, 
mais la partie des données de ce plan qui apparaît dans la timeline. Un montage par coulissement 
vous permet de modifier simultanément les points de départ et d’arrivée d’un plan.
Lorsque vous disposez des plans dans la timeline de manière à ce que leurs points de montage 
coïncident avec les temps musicaux ou d’autres points de synchronisation fixes d’un film, ils 
doivent rester en position pour préserver cet alignement. Cela limite considérablement les possibilités d’ajustement d’un plan dans la mesure où vous ne pouvez pas modifier sa durée ni le 
déplacer dans la timeline. Vous pouvez uniquement déplacer simultanément ses points de départ 
et d’arrivée en conservant sa durée et sa position.
La partie du plan visible dans le projet change, mais pas la position du plan dans la timeline. Les 
plans voisins ne sont pas affectés et la durée globale du projet reste la même.
00:00:10:00 00:00:30:00
A B C
Avant montage
00:00:17:00 00:00:37:00
Après montage
A B CChapitre 8 Montage de votre projet 141
Dans l’exemple ci-dessus, le montage par coulissement modifie les points de départ et d’arrivée 
du plan B, mais pas sa durée ni sa position dans la timeline. Lors de la lecture du projet, une autre 
partie des données du plan B est affichée.
Remarque : Pour qu’un plan puisse être coulissé, il doit présenter des poignées de données à 
chacune de ses extrémités; en d’autres termes, des données supplémentaires doivent être disponibles au début et à la fin du plan. Si vous avez du mal à faire coulisser un plan, vérifiez que des 
poignées de données sont disponibles à chacune de ses extrémités. Vous pouvez double-cliquer 
sur n’importe quel point de montage pour afficher ou ajuster ses poignées de données dans 
l’éditeur de précision.
Si aucune poignée de données n’est disponible, utilisez plutôt l’outil Position . Pour en savoir 
plus sur l’outil Position, consultez la section Disposition des plans dans la timeline à la page 124.
Pour un affichage plus précis lors des montages de plans contigus, vous pouvez activer l’option 
« Afficher les commentaires détaillés sur le trimming » dans les préférences de Final Cut Pro. Pour 
un montage par coulissement, ce « double » affichage dans le visualiseur présente les points 
de départ et d’arrivée du plan que vous faites coulisser. Pour en savoir plus, consultez Affichage 
détaillé des commentaires sur le trimming à la page 145.
Coulissement d’un plan dans la timeline
1 Choisissez l’outil Trim dans le menu local Outils de la barre d’outils (ou appuyez sur la touche T).
Le pointeur prend la forme de l’outil Trim .
Conseil : Vous pouvez activer temporairement l’outil Trim en maintenant la touche T enfoncée. 
Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.
2 Faites glisser un plan vers la gauche ou la droite.Chapitre 8 Montage de votre projet 142
Pendant que vous faites glisser le plan, un champ de timecode indique la durée dont vous déplacez les points de départ et d’arrivée. Les sélections de bordure jaunes sur les points de départ et 
d’arrivée indiquent un montage par coulissement.
Nouvelle position de l’image
Les sélections jaunes aux bordures des 
points d’entrée et de sortie indiquent un 
montage par coulissement.
Position d’origine de l’image
Lorsque vous relâchez le bouton de la souris, le plan coulissé apparaît dans la timeline avec de 
nouveaux points de départ et d’arrivée.
Vous pouvez également faire coulisser le plan sélectionné à l’aide de raccourcis clavier en effectuant l’une des opérations suivantes: 
• Déplacer légèrement les points de départ et d’arrivée (d’une ou de 10 images) vers la gauche 
ou la droite.
• Saisir la durée dont vous souhaitez faire coulisser le plan vers la gauche ou la droite.
Remarque : Si le point de départ départ ou d’arrivée devient rouge pendant que vous faites 
glisser le plan, cela signifie que vous avez atteint la fin des données disponibles pour ce 
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Réalisation de montages par glissement à l’aide de l’outil Trim
Un montage par glissement vous permet de repositionner un plan dans la timeline entre deux 
autres plans sans créer de vide. Le contenu et la durée du plan ne changent pas, seule sa position dans la timeline est modifiée. Lorsque vous faites glisser un plan, les plans adjacents sont 
allongés et raccourcis pour s’adapter à la nouvelle position du plan. La durée globale de ces trois 
plans ainsi que la durée totale du projet ne sont pas modifiées.
A B C
A B C
Avant montage
Après montage
Remarque : Pour pouvoir faire glisser un plan entre deux autres, les plans précédent et suivant 
doivent présenter des poignées de données (données supplémentaires disponibles au-delà du 
point de montage). Vous pouvez double-cliquer sur n’importe quel point de montage pour afficher ou ajuster ses poignées de données dans l’éditeur de précision.
Si aucune poignée de données n’est disponible, utilisez plutôt l’outil Position . Pour en savoir 
plus sur l’outil Position, consultez la section Disposition des plans dans la timeline à la page 124.
Pour un affichage plus précis lors des montages de plans contigus, vous pouvez activer l’option 
« Afficher les commentaires détaillés sur le trimming » dans les préférences de Final Cut Pro. Pour 
un montage par glissement, ce « double » affichage dans le visualiseur présente les deux points 
de montage que vous ajustez : le point d’arrivée du plan précédent et le point de départ du plan 
suivant. Pour en savoir plus, consultez Affichage détaillé des commentaires sur le trimming à la 
page 145.
Glissement d’un plan dans la timeline
1 Choisissez l’outil Trim dans le menu local Outils de la barre d’outils (ou appuyez sur la touche T).
Le pointeur prend la forme de l’outil Trim .
Conseil : Vous pouvez activer temporairement l’outil Trim en maintenant la touche T enfoncée. 
Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.
2 Faites glisser un plan vers la gauche ou la droite en maintenant la touche Option enfoncée.Chapitre 8 Montage de votre projet 144
Les sélections jaunes sur les plans voisins indiquent un montage par glissement.
Position d’origine dans la timeline
Les sélections jaunes sur les plans voisins 
indiquent un montage par glissement.
Pendant que vous faites glisser le plan, un champ de timecode indique la durée dont vous le 
déplacez dans la timeline.
La durée de ce plan reste la même. 
Ce plan est plus long. Ce plan est plus court.
Nouvelle position dans la timeline
Lorsque vous relâchez le bouton de la souris, le plan glissé apparaît à son nouvel emplacement 
dans la timeline. Un trim est appliqué aux plans adjacents pour les adapter à la nouvelle position du plan.
Vous pouvez également faire glisser le plan sélectionné à l’aide de raccourcis clavier en effectuant l’une des opérations suivantes: 
• Le déplacer légèrement (d’une ou de 10 images) vers la gauche ou la droite.
• Saisir la durée dont vous souhaitez faire glisser le plan vers la gauche ou la droite.
Pour en savoir plus, consultez Disposition des plans dans la timeline à la page 124.
Remarque : Si l’un des points de montage devient rouge pendant que vous faites glisser le plan, 
cela signifie que vous avez atteint la fin des données disponibles pour ce côté du plan.Chapitre 8 Montage de votre projet 145
Affichage détaillé des commentaires sur le trimming
Pour un affichage plus précis lors des montages de plans contigus ou connectés, vous pouvez 
activer l’option « Afficher les commentaires détaillés sur le trimming » dans les préférences de 
Final Cut Pro. Par exemple, pour un montage Ripple simple, ce « double » affichage dans le visualiseur présente le point d’arrivée du plan de gauche et le point de départ du plan de droite.
Cet affichage est disponible pour les montages Ripple, Roll, par coulissement et par glissement, 
ainsi que pour les opérations de trim dans l’éditeur de précision.
Activation de l’affichage de trim détaillé
1 Sélectionnez Final Cut Pro > Préférences (ou appuyez sur les touches Commande + virgule).
2 Cliquez sur Montage.
3 Dans la section Timeline, cochez la case « Afficher les commentaires détaillés sur le trimming ».
Le « double » affichage apparaît dans le visualiseur chaque fois que vous utilisez un type de 
montage pris en charge ou que vous effectuez un trim dans l’éditeur de précision.
Conseil : Vous pouvez utiliser la touche Option pour modifier à la volée l’affichage de trim 
détaillé. Si l’affichage de trim détaillé est activé, appuyez sur la touche Option pour le désactiver. 
Si l’affichage de trim détaillé est désactivé, appuyez sur la touche Option pour basculer entre l’affichage du point d’arrivée du plan de gauche et l’affichage du point de départ du plan de droite.
Affichage et navigation
Zoom et défilement dans la timeline
Pouvoir afficher et atteindre n’importe quel point de votre projet est essentiel pour un montage 
et une narration efficaces. La présentation de la timeline peut être modifiée de diverses manières. 
Connaître les raccourcis clavier peut vous faire gagner du temps.
Adaptation de l’intégralité du contenu de la timeline à la fenêtre
Qu’il n’y ait qu’un seul plan affiché suite à un zoom avant ou que tous les plans de votre projet 
apparaissent à gauche de la timeline suite à un zoom arrière, vous pouvez ajuster rapidement la 
présentation de sorte que tous les plans tiennent dans la partie visible de la timeline et qu’aucun 
défilement ne soit nécessaire.Chapitre 8 Montage de votre projet 146
m Choisissez Présentation > Zoom pour adapter à la fenêtre (ou appuyez sur Maj + Z).
Avant la sélection de Zoom pour adapter à la fenêtre
Après la sélection de Zoom pour adapter à la fenêtre
Zoom avant et arrière sur la timeline à l’aide du curseur Zoom
m Pour effectuer un zoom avant sur la timeline : faites glisser le curseur Zoom vers la droite ou 
appuyez sur Commande + signe plus (+).
m Pour effectuer un zoom arrière sur la timeline : faites glisser le curseur Zoom vers la gauche ou 
appuyez sur Commande + signe moins (–).
Zoom avant et arrière sur la timeline à l’aide de l’outil Zoom
1 Choisissez l’outil Zoom dans le menu local Outils de la barre d’outils (ou appuyez sur la 
touche Z).
Le pointeur prend la forme de l’outil Zoom .Chapitre 8 Montage de votre projet 147
Conseil : Vous pouvez activer temporairement l’outil Zoom en maintenant la touche Z enfoncée. 
Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.
2 Procédez de l’une des manières suivantes:
• Pour effectuer un zoom avant sur la timeline : cliquez sur la section de la timeline sur laquelle 
vous voulez effectuer un zoom avant. (Vous pouvez également faire glisser le pointeur sur une 
zone de la timeline pour limiter le zoom avant à cette zone.)
Cliquez plusieurs fois pour poursuivre le zoom avant.
• Pour effectuer un zoom arrière sur la timeline : tout en maintenant la touche Option enfoncée, 
cliquez sur la section de la timeline sur laquelle vous voulez effectuer un zoom arrière.
Cliquez plusieurs fois tout en maintenant la touche Option enfoncée pour poursuivre le 
zoom arrière.
Défilement d’une timeline sur laquelle vous avez effectué un zoom avant
1 Effectuez un zoom avant sur la timeline jusqu’à ce que vous ne voyiez plus qu’une partie 
du projet.
2 Procédez de l’une des manières suivantes:
• Faites glisser horizontalement le curseur situé au bas de la timeline.
• Faites glisser verticalement le curseur situé sur le côté droit de la timeline.
• Choisissez l’outil Main dans le menu local Outils de la barre d’outils (ou appuyez sur la 
touche H), puis faites glisser la souris dans la timeline. 
Conseil : Vous pouvez activer temporairement l’outil Main en maintenant la touche H enfoncée. 
Lorsque vous relâchez celle-ci, l’outil précédent est réactivé.
Ajustement des réglages de la timeline
Dans Final Cut Pro, les options d’affichage de la timeline peuvent être modifiées très facilement. 
Par exemple, vous pouvez afficher les plans avec ou sans les pellicules vidéo ou les formes 
d’onde audio. Vous pouvez également modifier la hauteur des plans ou la taille des pellicules ou 
des formes d’onde audio en fonction des vignettes vidéo qui apparaissent dans la pellicule de 
chaque plan dans la timeline. Vous pouvez aussi n’afficher que les étiquettes des plans.
Le magnétisme simplifie et accélère certaines opérations, notamment l’alignement d’un plan 
vidéo avec un clip audio ou le positionnement de la tête de lecture sur un marqueur précis. 
Lorsque le magnétisme est activé, les éléments que vous déplacez dans la timeline semblent se 
caler sur certains points de celle-ci. Cette fonction peut vous aider à aligner rapidement les montages sur d’autres éléments du projet. Chapitre 8 Montage de votre projet 148
Le magnétisme affecte les fonctions de nombreux outils de montage dans Final Cut Pro, notamment les outils de sélection, Trim, Position, Sélection de plage et Lame de rasoir. Plusieurs élé-
ments déclenchent le magnétisme dans la timeline :
• les limites des plans (points de départ et d’arrivée),
• la tête de lecture et le skimmer,
• Marqueurs
• les images clés,
• les sélections de plage.
 Modification de l’apparence et de la hauteur du plan de la timeline
1 Cliquez sur le bouton Apparence du plan situé dans le coin inférieur droit de la timeline.
La fenêtre Apparence du plan s'affiche.
2 Procédez de l’une des manières suivantes:
• Pour afficher uniquement les plans avec des grandes formes d'onde audio : cliquez sur le bouton 
Apparence du plan le plus à gauche (ou appuyez sur Option + Contrôle + 1).
• Pour afficher les plans avec des grandes formes d'onde audio et des petites pellicules: cliquez 
sur le deuxième bouton Apparence du plan depuis la gauche (ou appuyez sur Option + 
Contrôle + 2).
• Pour afficher les plans avec des grandes formes d'onde audio et des pellicules vidéo de même taille : 
cliquez sur le troisième bouton Apparence du plan depuis la gauche (ou appuyez sur Option + 
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• Pour afficher les plans avec de petites formes d'onde audio et de grandes pellicules: cliquez sur le 
troisième bouton Apparence du plan depuis la droite (ou appuyez sur Option + Contrôle + 4).
• Pour afficher uniquement les plans avec des grandes pellicules: cliquez sur le deuxième bouton 
Apparence du plan depuis la droite (ou appuyez sur Option + Contrôle + 5).
• Pour afficher uniquement les étiquettes de plan : cliquez sur le bouton Apparence du plan le plus 
à droite (ou appuyez sur Option + Contrôle + 6).
Conseil : Pour augmenter la taille des formes d'onde audio pour la timeline, appuyez sur 
Option + Contrôle + Flèche vers le haut. Pour réduire la taille des formes d'onde audio pour la 
timeline, appuyez sur Option + Contrôle + Flèche vers le bas.
3 Pour ajuster la hauteur des plans dans la timeline, faites glisser le curseur Hauteur du plan vers la 
gauche pour diminuer la hauteur des plans, ou vers la droite pour l’augmenter.
4 cochez ou décochez la case Afficher les connections pour activer ou désactiver les plans connectés et les scénarios.
5 Pour ajuster l'affichage de l'étiquette du plan, choisissez une option dans le menu local Afficher :
• Pour afficher les plans en fonction du nom: choisir Nom des plans.
• Pour afficher les plans en fonction du rôle : choisir Rôles des plans.
• Pour afficher les plans multicam en fonction des angles vidéo et audio actifs: choisir Nom des 
plans ou Angles.
Activation ou désactivation du magnétisme
Tout en étant extrêmement utile, le magnétisme peut parfois constituer un obstacle si vous 
tentez de déplacer un plan de quelques images uniquement au sein d’une série de marqueurs et 
de limites de plans et si vous ne souhaitez pas créer de magnétisme en aucun de ces points. Mais 
sachez que vous pouvez activer et désactiver facilement le magnétisme à tout moment, même 
lorsque vous êtes en train de glisser un plan.
Procédez de l’une des manières suivantes:
m Choisissez Présentation > Magnétisme (ou appuyez sur la touche N).
Une coche indique que le magnétisme est activé. Vous pouvez appuyer sur la touche N pour 
activer ou désactiver le magnétisme pendant que vous faites glisser un plan.
m Cliquez sur le bouton Magnétisme dans le coin supérieur droit de la timeline.
Lorsque le magnétisme est activé, le bouton Magnétisme apparaît en bleu.
Conseil : Vous pouvez activer ou désactiver temporairement le magnétisme en maintenant la 
touche N enfoncée. Lorsque vous relâchez celle-ci, le magnétisme revient à l’état précédent.Chapitre 8 Montage de votre projet 150
Navigation au sein de votre projet
La possibilité d’atteindre instantanément n’importe quel point de la timeline est l’un des principaux avantages d’un environnement de montage non linéaire. Final Cut Pro offre différents 
moyens permettant de naviguer rapidement et facilement dans votre projet.
Vous pouvez également utiliser une présentation textuelle de la timeline pour naviguer et effectuer des recherches dans votre projet. Pour en savoir plus, consultez Utilisation de l’index de la 
timeline pour afficher votre projet, y naviguer et effectuer des recherches à la page 152.
Vous pouvez utiliser les touches J, K et L pour lire un projet à différentes vitesses ou dans diffé-
rentes directions. Pour en savoir plus, consultez Lecture du média à la page 79.
Navigation par survol, clic ou glissement
m Pour survoler la timeline jusqu’à une image de votre projet: déplacez le skimmer vers la gauche et la 
droite sur les plans de la timeline pour les visionner rapidement dans le visualiseur.
m Pour déplacer la tête de lecture jusqu’à une image de votre projet: déplacez la tête de lecture en 
cliquant sur la règle en haut de la timeline ou en y faisant glisser le pointeur, ou en cliquant sur 
l’arrière-plan de la timeline.
Conseil : Pour éviter que la tête de lecture ne bouge quand vous sélectionnez un plan dans la 
timeline, appuyez sur Option lorsque vous cliquez.
Navigation image par image
Pour trouver plus facilement des images précises d’un plan, vous pouvez parcourir la pellicule 
image par image au lieu de la survoler. 
1 Dans la timeline ou le navigateur d’événements, placez votre pointeur sur une pellicule et 
cliquez. 
2 Effectuez l’une des opérations suivantes:
• Pour reculer par incréments d’une image : Choisissez Marquer > Précédent > Image (ou appuyez 
sur la touche Flèche gauche).
• Pour avancer par incréments d’une image : choisissez Marquer > Suivant > Image (ou appuyez 
sur la touche Flèche droite).
Navigation sous-image par sous-image
Vous pouvez naviguer dans les plans sous-image par sous-image. Une sous-image possède une 
durée égale à 1/80 de celle d’une image vidéo et constitue par conséquent une unité de réfé-
rence plus précise pour la visualisation ou la modification des formes d’onde audio agrandies au 
niveau de l’échantillon.
Remarque : vous ne pouvez pas modifier la vidéo au niveau des sous-images.
1 Dans la timeline ou le navigateur d’événements, placez votre pointeur sur un plan et cliquez.
2 Effectuez l’une des opérations suivantes:
• Pour reculer par incréments d’une sous-image : appuyez sur Commande + Flèche gauche.
• Pour avancer par incréments d’une sous-image : appuyez sur Commande + Flèche droite.
Remarque : vous pouvez modifier l’affichage du temps dans le panneau de contrôle pour qu’il 
utilise les sous-images. Pour en savoir plus, consultez Modification des préférences à la page 437.Chapitre 8 Montage de votre projet 151
Navigation par saut
Utilisez les techniques suivantes pour déplacer rapidement la tête de lecture d’un point à un 
autre dans la timeline.
m Pour atteindre le point de montage suivant: choisissez Marquer > Suivant > Montage (ou appuyez 
sur la touche fléchée vers le bas), ou cliquez sur le bouton Montage suivant situé sous 
le visualiseur.
m Pour atteindre le point de montage précédent: choisissez Marquer > Précédent > Montage (ou 
appuyez sur la touche Flèche vers le haut), ou cliquez sur le bouton Montage précédent situé 
sous le visualiseur.
m Pour atteindre le début du projet: choisissez Marquer > Aller à > Début (ou appuyez sur la 
touche Début).
m Pour atteindre la fin du projet: choisissez Marquer > Aller à > Fin (ou appuyez sur la touche Fin).
m Pour atteindre le marqueur suivant: choisissez Marquer > Suivant > Marqueur, ou appuyez sur 
Contrôle + Apostrophe (’).
m Pour atteindre le marqueur précédent: choisissez Marquer > Précédent > Marqueur, ou appuyez 
sur Contrôle + Point-virgule (;).
Pour en savoir plus sur les marqueurs, consultez la section Présentation des marqueurs à la 
page 156.
Navigation à l’aide du timecode
Le timecode est un signal enregistré avec la vidéo et identifiant chaque image de manière 
unique. Lorsque vous lisez un plan dans le navigateur d’événements, son signal de timecode 
apparaît dans le panneau de contrôle, au centre de la barre d’outils de Final Cut Pro, au format 
suivant :
Timecode
Heures
Minutes
Secondes
Images
Le timecode prend en charge de nombreuses fonctions de Final Cut Pro, notamment la lecture 
dans la timeline, la synchronisation des éléments vidéo et audio, ainsi que l’ajout, le déplacement 
et le trim de plans. En outre, le timecode vous permet de naviguer au sein des projets dans la 
timeline et de connaître la durée des plans, des sélections de plage et des projets.
Navigation par saisie d’une valeur de timecode
Pour déplacer la tête de lecture vers un nouvel emplacement de la timeline, effectuez l’une des 
opérations suivantes:
m Pour déplacer la tête de lecture vers un emplacement précis de la timeline : cliquez une fois au centre 
du panneau de contrôle (ou appuyez sur Contrôle + P), saisissez la nouvelle valeur de timecode, 
puis appuyez sur Entrée. 
Par exemple, pour placer la tête de lecture au point 01:40:31:03, appuyez sur Contrôle + P, saisissez « 1403103 », puis appuyez sur Entrée.Chapitre 8 Montage de votre projet 152
m Pour déplacer la tête de lecture d’une durée de timecode : assurez-vous qu’aucun plan n’est sélectionné, appuyez sur la touche Plus(+) ou Moins(–), saisissez le nombre d’images, de secondes ou 
de minutes dont vous voulez déplacer la tête de lecture, puis appuyez sur Entrée.
Par exemple, si vous tapez « +1612 » et que vous appuyez sur Entrée, la tête de lecture avance de 
16 secondes et 12 images. 
Les nouvelles valeurs de timecode apparaissent dans le panneau de contrôle à mesure que vous 
tapez. Lorsque vous appuyez sur Entrée, la tête de lecture se déplace vers le nouvel emplacement de la timeline. 
Voici quelques conseils pour la saisie des valeurs de timecode :
• Il n’est pas nécessaire de saisir les caractères de séparation (deux-points). Final Cut Pro 
les ajoute automatiquement après chaque paire de chiffres. Par exemple, si vous saisissez 
« 01221419 », Final Cut Pro l’interprète comme 01:22:14:19 (1 heure, 22 minutes, 14 secondes et 
19 images).
• Si les champs de gauche ne contiennent que des zéros, il n’est pas nécessaire de les saisir. Par 
exemple, si vous saisissez « 1419 », Final Cut Pro l’interprète comme 00:00:14:19. De même, si 
vous saisissez « 253407 », Final Cut Pro l’interprète comme 00:25:34:07.
• Si les champs de droite ne contiennent que des zéros, vous pouvez utiliser des points à la 
place. Par exemple, pour atteindre le timecode 00:00:03:00, saisissez « 3. » (le chiffre 3 suivi d’un 
point). Pour accéder au timecode 03:00:00:00, tapez « 3... » (le chiffre 3 suivi de trois points). Au 
lieu d’un point, vous pouvez également utiliser une virgule, un signe plus, un signe moins, un 
deux-points, un point-virgule ou une esperluette. 
Remarque : Vous pouvez modifier l’affichage du temps dans le panneau de contrôle pour ne pré-
senter que le timecode, le timecode et les sous-images, uniquement les images ou uniquement 
les secondes. Pour en savoir plus, consultez Modification des préférences à la page 437.
Utilisation de l’index de la timeline pour afficher votre projet, y naviguer et 
effectuer des recherches
L’index de la timeline fournit une présentation textuelle des plans et des balises (divers types de 
marqueurs et de mots-clés) utilisés dans la timeline de votre projet. Vous pouvez facilement filtrer l’index de la timeline pour n’afficher que les éléments voulus.
Les plans sont 
répertoriés dans 
l’ordre dans lequel ils 
apparaissent dans la 
timeline.
Vous pouvez également utiliser l’index de la timeline pour naviguer dans celle-ci. La tête de lecture de l’index de la timeline apparaît dans la liste des éléments. Lorsque vous lisez un projet, elle 
se déplace vers le bas de la liste. Lorsque vous sélectionnez un élément dans l’index de la timeline, la tête de lecture se place automatiquement au début de cet élément. Chapitre 8 Montage de votre projet 153
Afficher ou masquer l’index de la timeline
m Cliquez sur le bouton « Index de la timeline » situé dans le coin inférieur gauche de la fenêtre 
principale de Final Cut Pro (ou appuyez sur Commande + Maj + 2).
L’index de la timeline apparaît dans le coin inférieur gauche de la fenêtre de Final Cut Pro.
La tête de lecture de l’index de 
la timeline se déplace en même 
temps que celle de la timeline.
Tête de lecture de 
la timeline
Affichage d’une liste d’éléments dans l’index de la timeline
1 Si l’index de la timeline n’est pas encore ouvert, cliquez sur le bouton « Index de la timeline » 
situé dans le coin inférieur gauche de la fenêtre principale de Final Cut Pro (ou appuyez sur 
Commande + Maj + 2).
2 Procédez de l’une des façons suivantes:
• Pour afficher la liste des plans utilisés dans la timeline, dans l’ordre chronologique : cliquez sur le 
bouton Plans en haut.
Procédez de l’une des façons suivantes:
• Modifiez le nom des plans.
• Affichez une liste de plans en fonction du timecode dans la colonne Position.
• Affichez, réattribuez et modifiez des rôles dans la colonne Rôles.Chapitre 8 Montage de votre projet 154
• Affichez et ajoutez des notes dans la colonne Notes.
• Affichez les angles actifs des plans multicam dans la colonne Angle actif.
Vous pouvez spécifier les colonnes à afficher en cliquant sur l’en-tête d’une colonne 
tout en maintenant la touche Contrôle enfoncée et en choisissant une option dans le 
menu contextuel.
Vous pouvez indiquer les éléments à afficher en cliquant sur le bouton Tout, Vidéo, Audio ou 
Titres au bas de l’index de la timeline. 
• Pour afficher la liste de toutes les balises affectées aux plans de la timeline, dans l’ordre chronologique : cliquez sur le bouton Balises en haut.
Tâche non terminée
Mot-clé
Tâche terminée
Marqueur de chapitre
Marqueur standard
Par défaut, toutes les balises sont affichées. Vous pouvez indiquer les éléments à afficher en 
cliquant sur un bouton au bas de l’index de la timeline. Vous pouvez afficher les marqueurs, les 
mots-clés, les mots-clés d’analyse, les tâches non terminées, les tâches terminées et les marqueurs de chapitre. 
Remarque : Les tâches sont des types de marqueurs.Chapitre 8 Montage de votre projet 155
• Pour afficher une liste de plans organisée en fonction du rôle dans la timeline : cliquez sur le 
bouton Rôles en haut.
Sélectionnez un nom de rôle dans la liste pour mettre en surbrillance dans la timeline tous 
les plans auxquels ce rôle a été attribué. Sélectionnez ou désélectionnez les cases en regard 
des rôles que vous voulez activer ou désactiver dans la timeline. Lorsqu’une case est désélectionnée, il n’est plus possible de voir ou d’entendre les plans auxquels ce rôle a été attribué 
lorsque vous les lisez dans votre projet. Pour en savoir plus, consultez Affichage des plans en 
fonction du rôle dans la timeline à la page 316.
Modification d’un marqueur Tâche
Dans l’index de la timeline, vous pouvez changer rapidement l’état d’un marqueur Tâche pour 
indiquer qu’une tâche est terminée ou non.
1 Si l’index de la timeline n’est pas encore ouvert, cliquez sur le bouton « Index de la timeline » 
situé dans le coin inférieur gauche de la fenêtre principale de Final Cut Pro (ou appuyez sur 
Commande + Maj + 2).
2 Cliquez sur la case d’un marqueur Tâche.
• Si le marqueur était rouge (tâche non terminée), il devient vert (tâche terminée).
• Si le marqueur était vert (tâche terminée), il devient rouge (tâche non terminée).
Recherche d’éléments dans l’index de la timeline
1 Si l’index de la timeline n’est pas encore ouvert, cliquez sur le bouton « Index de la timeline » 
situé dans le coin inférieur gauche de la fenêtre principale de Final Cut Pro (ou appuyez sur 
Commande + Maj + 2).
2 Cliquez sur Plans pour rechercher des plans ou sur Balises pour rechercher des balises.
3 Saisissez un terme dans le champ de recherche situé en haut de l’index de la timeline. 
Vous pouvez rechercher des plans, des mots-clés et des marqueurs (y compris des tâches).
Conseil : La timeline étant activée, choisissez Édition > Rechercher (ou appuyez sur 
Commande + F). L’index de la timeline s’ouvre et vous pouvez saisir le terme recherché dans le 
champ de recherche, qui est actif.Chapitre 8 Montage de votre projet 156
Utilisation de marqueurs
Présentation des marqueurs
Les marqueurs sont des points de référence que vous pouvez placer dans les plans pour localiser, identifier, annoter et accéder à des images spécifiques. Lors du montage, les marqueurs 
sont particulièrement utiles pour synchroniser deux plans ou plus à un emplacement précis. Par 
exemple, vous pouvez utiliser un marqueur pour identifier une image où une porte claque, puis 
caler par magnétisme un effet sonore sur ce marqueur. Les marqueurs permettent d’ajouter des 
remarques de montage ou d’autres informations descriptives à un emplacement précis d’un 
plan. Lorsque vous ajoutez des marqueurs de chapitre à des points particuliers de votre projet, 
les spectateurs peuvent alors utiliser les marqueurs pour accéder directement à ces points dans 
le film après qu’il ait été exporté ou gravé sur DVD ou disque Blu-ray. Vous pouvez aussi faire 
appel à des marqueurs pour la gestion des tâches. 
Ils se classifient en marqueurs standard (bleus), en marqueurs de chapitre (orange), en tâches à 
réaliser (rouges) ou en tâches accomplies (vertes).
Marqueur standard Marqueur de chapitre
Tâche Tâche 
terminée
Les marqueurs s’utilisent de la même façon dans le navigateur d’événements et dans la timeline.
Ajout et suppression de marqueurs
Vous pouvez ajouter et supprimer facilement des marqueurs. Si vous ajoutez des marqueurs 
à des plans dans le navigateur d’événements, ils apparaissent aussi bien dans la présentation 
en pellicule que dans la présentation en liste. Lorsque vous ajoutez des plans assortis de marqueurs à la timeline, les marqueurs sont visibles aussi bien dans la timeline que dans l’index de 
la timeline.
Ajout d’un marqueur à un plan dans le navigateur d’événements ou la timeline 
1 Pour indiquer l’endroit où vous souhaitez ajouter un marqueur, effectuez l’une des opérations 
suivantes:
• Effectuez un survol jusqu’à l’emplacement voulu.
• Lisez le plan, puis, lorsque la tête de lecture atteint l’emplacement où vous voulez ajouter le 
marqueur, appuyez sur la barre d’espace pour arrêter la lecture.Chapitre 8 Montage de votre projet 157
Pour en savoir plus sur le positionnement du skimmer et de la tête de lecture, consultez la section Navigation au sein de votre projet à la page 150.
2 Procédez de l’une des manières suivantes:
• Pour ajouter un marqueur: choisissez Marquer > Marqueurs > Ajouter un marqueur (ou 
appuyez sur la touche M).
Conseil : Pour ajouter des marqueurs à la volée, appuyez simplement sur la touche M pendant 
la lecture d’un plan.
• Pour ajouter un marqueur et afficher ses informations: choisissez Marquer > Marqueurs > 
Ajouter et modifier (ou appuyez sur Option + M).
Lorsque vous ajoutez un marqueur de cette façon, ses informations sont automatiquement 
affichées. 
Le marqueur apparaît au-dessus du plan dans le navigateur d’événements ou la timeline.
Remarque : Les marqueurs ajoutés aux plans dans le navigateur d’événements apparaissent dans 
la présentation en liste et en pellicule. 
Suppression d’un marqueur
Procédez de l’une des manières suivantes:
m Naviguez jusqu’au marqueur, puis choisissez Marquer > Marqueurs > Supprimer le marqueur (ou 
appuyez sur Contrôle + M).
m Sélectionnez un ou plusieurs plans, puis choisissez Marquer > Marqueurs > Supprimer dans 
la sélection.
m Double-cliquez sur un marqueur pour ouvrir la fenêtre Marqueur, puis cliquez sur le 
bouton Supprimer.
m Appuyez sur la touche Contrôle tout en cliquant sur le marqueur que vous souhaitez supprimer, 
puis choisissez Supprimer le marqueur dans le menu contextuel.Chapitre 8 Montage de votre projet 158
Modification, déplacement et accès à des marqueurs
Vous pouvez afficher et modifier les informations des marqueurs, et déplacer des marqueurs au 
sein d’un même plan ou d’un plan à un autre.
Modification d’informations de marqueurs et changement de types de marqueurs
Par défaut, les nouveaux marqueurs sont des marqueurs standard bleus reprenant du texte 
comme repère d’emplacement. Vous pouvez modifier ce texte à tout moment et avez la possibilité de changer le type du marqueur parmi les types de marqueurs proposés, entre autres les 
marqueurs de chapitre, les tâches à réaliser et les tâches terminées.
1 Pour afficher les informations d’un marqueur, effectuez l’une des opérations suivantes:
• Sélectionnez le marqueur, puis choisissez Marquer > Marqueurs > Modifier le marqueur (ou 
appuyez sur Maj + M).
• Cliquez sur le marqueur tout en maintenant la touche Contrôle enfoncée, puis choisissez 
Modifier le marqueur dans le menu contextuel.
• Double-cliquez sur le marqueur.
Les informations du marqueur apparaissent au-dessus de lui.
Bouton de marqueur de chapitre
Bouton de tâche à réaliser
Bouton de marqueur standard
2 Pour modifier le marqueur, effectuez l’une des opérations suivantes:
• Pour modifier le texte descriptif du marqueur: saisissez le nouveau texte dans le champ. (Le texte 
est automatiquement sélectionné à l’affichage des informations sur le marqueur : il n’est donc 
pas nécessaire de le sélectionner.)
• Pour convertir le marqueur en marqueur de chapitre : cliquez sur le bouton Marqueur de chapitre.
Le marqueur devient orange pour refléter sa conversion en marqueur de chapitre. Pour en 
savoir plus, consultez Gestion des marqueurs de chapitre et de leur vignette à la page 160.
• Pour convertir le marqueur en tâche : cliquez sur le bouton Tâche.
Le marqueur devient rouge.
• Pour indiquer qu’une tâche est terminée : cochez la case Terminée.Chapitre 8 Montage de votre projet 159
Le marqueur devient vert.
Cochez la case Terminée.
Bouton de tâche à réaliser
• Pour convertir le marqueur en marqueur standard : cliquez sur le bouton Marqueur standard.
Le marqueur devient bleu.
3 Cliquez sur Terminé.
Déplacement ou copie d’un marqueur
Vous pouvez déplacer ou copier des marqueurs à l’aide des commandes Mac Couper, Copier et 
Coller habituelles.
1 Cliquez sur le marqueur à déplacer ou à copier tout en maintenant la touche Contrôle enfoncée, 
puis choisissez une option dans le menu contextuel.
• Pour déplacer le marqueur: choisissez Couper le marqueur.
• Pour copier le marqueur: choisissez Copier le marqueur.
2 Placez le skimmer ou la tête de lecture à l’endroit où vous voulez coller le marqueur.
3 Choisissez Édition > Coller (ou appuyez sur Commande +V).
Le marqueur apparaît au nouvel emplacement.
Déplacement d’un marqueur d’une image à la fois
1 Sélectionnez un marqueur.
2 Procédez de l’une des manières suivantes:
• Pour déplacer le marqueur d’une image vers la droite : choisissez Marquer > Marqueurs > Pousser 
vers la droite, ou appuyez sur Contrôle + point (.).
• Pour déplacer le marqueur d’une image vers la gauche : choisissez Marquer > Marqueurs > 
Pousser vers la gauche, ou appuyez sur Contrôle + virgule (,).
Passage d’un marqueur à l’autre
Vous pouvez passer rapidement d’un marqueur à un autre dans la timeline ou le navigateur 
d’événements.
m Pour atteindre le marqueur suivant: choisissez Marquer > Suivant > Marqueur, ou appuyez sur 
Contrôle + Apostrophe (’).
m Pour atteindre le marqueur précédent: choisissez Marquer > Précédent > Marqueur, ou appuyez 
sur Contrôle + point-virgule (;).Chapitre 8 Montage de votre projet 160
Gestion des marqueurs de chapitre et de leur vignette
Les marqueurs de chapitre représentent une fonctionnalité standard des DVD, des disques Bluray et des podcasts. Il vous est possible d’ajouter des marqueurs de chapitre à votre projet afin 
que, lorsque vous partagez votre film terminé, les spectateurs puissent utiliser les marqueurs 
pour accéder directement à ces points dans le film. Les applications et les dispositifs qui reconnaissent les marqueurs de chapitre Final Cut Pro lors de la reproduction incluent iTunes, iPod, 
iPhone, iPad, Apple TV, QuickTime Player, Lecteur DVD Player et la plupart des lecteurs DVD et 
Blu-ray standard.
Les marqueurs de chapitre simplifient le passage à une section voulue. Ils permettent également 
à Compressor, une application de transcodage professionnelle d’Apple, et à d’autres applications 
de création de DVD et de disques Blu-ray de créer une liste ou un menu navigable des chapitres, 
tel qu’un index des chapitres. Cependant, même dans des projets simples dépourvus de menus 
(tels que les podcasts), les marqueurs de chapitre offrent aux spectateurs et aux auditeurs la possibilité de passer rapidement des sections d’un programme par le biais des boutons Précédent et 
Suivant à travers leur application ou leur dispositif de lecture.
Une vignette de marqueur de chapitre constitue une image fixe qui représente un chapitre particulier. Final Cut Pro vous permet de sélectionner une image vidéo particulière tirée d’un plan 
ou d’un scénario que vous marquez comme vignette de marqueur de chapitre. Dans les applications ou appareils de reproduction pris en charge, les vignettes de marqueurs de chapitre repré-
sentent les chapitres correspondants.
Création d’un marqueur de chapitre
1 Ajoutez un marqueur à un plan dans la timeline à l’endroit où vous voulez que le 
chapitre commence.
Par défaut, Final Cut Pro crée un marqueur standard bleu.
2 Pour adapter le marqueur en marqueur de chapitre, double-cliquez dessus puis, lorsque les informations du marqueur s’affichent, cliquez sur le bouton Marqueur de chapitre.
Bouton de marqueur de chapitre
Bouton de tâche à réaliser
Bouton de marqueur standard
Le marqueur se convertit en marqueur de chapitre orange.
Définition d'une image de vignette du marqueur de chapitre
Après avoir défini un marqueur de chapitre, vous pouvez choisir une image vidéo appropriée 
pour représenter le chapitre donné.
1 Cliquez une fois sur le marqueur de chapitre dans la timeline pour le sélectionner.Chapitre 8 Montage de votre projet 161
Le marqueur s’agrandit légèrement pour indiquer qu’il est sélectionné, et le repère d’une 
vignette de marqueur de chapitre apparaît à droite du marqueur de chapitre choisi. Par défaut, la 
vignette du marqueur de chapitre apparaît 11 images après le marqueur en question. 
Marqueur de chapitre
Épingle de vignette de 
marqueur de chapitre
2 Pour définir l’image vidéo représentant la vignette du marqueur de chapitre, faites glisser horizontalement l’épingle dans la timeline.
Pendant le glissement, le visualiseur affiche l’image vidéo correspondante.
Faites glisser horizontalement 
l’épingle dans la timeline.
Remarque : La vignette de marqueur de chapitre constitue une image composite de l’emplacement en question dans la timeline et inclut les titres et toute autre image superposée.
Si le marqueur de chapitre se trouve dans le scénario principal, vous pouvez faire glisser le repère 
de sa vignette complètement au début ou à la fin du scénario principal. Si le marqueur de chapitre se trouve dans un scénario connecté, vous pouvez faire glisser le repère de sa vignette 
complètement au début ou à la fin du scénario connecté.
Pour en savoir plus sur le partage de votre film une fois terminé, consultez Présentation du partage de projets à la page 394.
Correction des problèmes de tremblement excessif et d’obturateur 
roulant
Vous pouvez lisser les tremblements d’un plan en corrigeant les problèmes de stabilisation ou 
d’obturateur roulant, ou les deux.
La fonctionnalité de stabilisation de Final Cut Pro réduit le mouvement de caméra dans votre 
vidéo de sorte que la lecture des parties tremblantes soit plus fluide. Vous pouvez à tout 
moment désactiver la stabilisation pour un plan afin qu’il soit lu tel qu’il a été enregistré.Chapitre 8 Montage de votre projet 162
La plupart des caméscopes et des appareils photo intègrent des capteurs d’image CMOS qui 
exposent progressivement l’image enregistrée, au lieu de le faire en une seule fois. Par consé-
quent, si la caméra bouge beaucoup pendant l’enregistrement ou si le mouvement enregistré 
est rapide, une déformation peut se produire. L’image apparaît alors tremblante ou inclinée. 
Final Cut Pro dispose d’une fonctionnalité d’obturateur roulant permettant de réduire cette 
déformation du mouvement. 
Correction d’un plan présentant un tremblement excessif ou une déformation provoquée par 
un obturateur roulant
1 Si le plan ne figure pas encore dans votre projet, ajoutez-le à la timeline et sélectionnez-le.
Remarque : Ces opérations s’appliquent aux sélections de plan complet, et non aux sélections de 
plage. Pour obtenir plus rapidement des résultats optimaux, isolez la section posant problème en 
coupant le plan à l’aide de l’outil Lame de rasoir dans la timeline. N’appliquez ensuite la correction qu’à la séquence vidéo à corriger.
2 Pour ouvrir l’inspecteur vidéo, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton Vidéo en haut de la fenêtre qui apparaît.
3 Dans l’inspecteur vidéo, effectuez l’une des opérations suivantes:
• Pour réduire le tremblement: cochez la case Stabilisation.
• Pour réduire la déformation provoquée par un obturateur roulant: cochez la case 
Obturateur roulant.
Lorsque vous activez l’option Stabilisation ou Obturateur roulant, sa case devient bleue.
4 Pour visualiser la correction, lancez la lecture du plan dans la timeline.
Pour désactiver la stabilisation ou les corrections d’obturateur roulant pour un plan, décochez la 
case Stabilisation ou Obturateur roulant.
Vous pouvez affiner les corrections en ajustant les réglages de stabilisation ou le réglage « Niveau 
d’obturateur roulant ».
Ajustement des réglages de stabilisation
Vous pouvez régler l’amplitude de la correction que la fonctionnalité de stabilisation applique.
La fonctionnalité de stabilisation présente deux phases indépendantes:
• Si vous appliquez la fonctionnalité de stabilisation à un plan, Final Cut Pro analyse alors les 
pixels dans les images successives pour déterminer la direction du mouvement de la caméra.
• Au cours du rendu ou de la lecture, Final Cut Pro utilise les données d’analyse du mouvement 
pour appliquer un effet de transformation à chaque image, qui compense le mouvement de 
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Utilisez l’un des trois curseurs indépendants de paramétrage de la stabilisation accessibles dans 
l’inspecteur vidéo pour contrôler la stabilité de votre prise de vue. Lorsque vous appliquez la 
stabilisation à un plan, ces trois paramètres sont alors définis selon une valeur moyenne de 2,5 
par défaut. Chaque paramètre peut être défini sur une valeur comprise entre 0,0 et 5,0. La valeur 
égale à 0,0 désactive le paramètre, alors que la valeur 5,0 applique la transformation la plus forte. 
Plus vous attribuez une valeur élevée à chaque paramètre, plus le mouvement de la caméra est 
compensé par rapport à cet axe.
x
Translation
y
x
Rotation
y
x
Échelle
y
z
1 Sélectionnez un plan dans la timeline et ouvrez l’inspecteur vidéo.
2 Procédez de l’une des façons suivantes:
• Pour régler le mouvement vertical ou latéral d’une prise de vue (axes X etY):faites glisser le curseur Lissage de la conversion.
• Pour ajuster la rotation autour du point central de l’image : faites glisser le curseur Lissage de 
la rotation.
• Pour adapter le mouvement de la caméra ou de l’objectif vers l’arrière ou vers l’avant (axe Z): faites 
glisser le curseur Lissage de l’échelle. 
Par exemple, si vous souhaitez éliminer le tremblement horizontal, vertical et rotatif, vous devez 
régler les paramètres « Lissage de la conversion » et « Lissage de la rotation » sur une valeur 
supérieure à 0. Il est conseillé de procéder à des tests pour savoir quelles sont les valeurs qui stabilisent le mieux votre prise.
Remarque : Lorsqu’un plan présente d’un mouvement trop prononcé (panoramique excessif, par 
exemple), la stabilisation du plan risque de produire des barres noires sur les bords de la vidéo.
Pour éviter les barres noires, vous pouvez :
• réduire les valeurs des paramètres « Lissage de la conversion », « Lissage de la rotation » et 
« Lissage de l’échelle » ;
• couper ou effectuer un trim du plan dans la timeline pour supprimer les sections présentant 
le plus de tremblement. (Vous pouvez retrouver les sections présentant des tremblements 
excessifs dans la fenêtre Mots-clés de l’index de la timeline. Cliquez dans ce cas sur les diffé-
rents mots-clés Tremblement excessif pour sélectionner les plages correspondantes dans la 
timeline.)
• Rognez les bords de la vidéo stabilisée pour supprimer les barres noires.9
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Présentation de l’audio
Final Cut Pro possède de nombreuses fonctionnalités conçues pour faciliter le traitement et le 
montage audio. Par exemple, vous pouvez utiliser Final Cut Pro pour analyser et améliorer automatiquement l’audio afin de résoudre des problèmes tels que le bruit ou des bourdonnements, 
d’ajouter des effets à vos plans, de synchroniser automatiquement les plans vidéo et les clips 
audio ou de faire correspondre l’audio entre deux plans.
Vous pouvez apporter les modifications suivantes aux clips ou aux composants audio au sein 
d’un plan :
• Monter plusieurs canaux audio : vous pouvez développer la partie audio de plans pour révéler 
et monter des composants audio jusqu’au niveau des canaux. Cela vous permet d’appliquer 
différents effets à divers composants ou canaux et de rationaliser le processus de réalisation 
d’estampes de son ou autres réglages rapides. Consultez Vue d’ensemble du montage audio à 
la page 175.
• Réglage du volume : ajustez rapidement le volume d’un plan directement dans la timeline ou 
dans l’inspecteur audio. Consultez Ajustement du volume à la page 179.
• Balance audio : tirez profit des préréglages intégrés de balance pour le son stéréo et Surround. 
Consultez Balance audio à la page 184.
• Ajout d’effets audio : ajoutez aux plans des effets Audio Unit, Logic ou personnalisés inclus dans 
Final Cut Pro, tels que de la réverbération. Consultez Ajout d’effets audio à la page 194.
• Ajout d’images clés pour automatiser le volume et les effets: faites évoluer le volume ou les 
réglages des effets au cours de la lecture d’un plan. Consultez Ajustement des effets audio à 
l’aide d’images clés à la page 200.
Remarque : Les fondus ne peuvent être créés que dans des plans. Pour appliquer des fondus 
entrants ou sortants aux plans à l’aide des poignées de fondu simples d’emploi, consultez 
Application d’un fondu entrant ou sortant à l’audio à la page 181
Dans Final Cut Pro, les outils utilisés pour le montage audio sont les mêmes que ceux du montage vidéo. Les fonctionnalités de montage indiquées ci-dessous sont présentées dans d’autres 
sections de l’Aide Final Cut Pro.
• Changement de mode de montage : réglez le mode de montage d’un plan pour vous concentrer 
sur la vidéo uniquement ou sur l’audio uniquement. Consultez Ajout de plans en mode vidéo 
uniquement ou audio uniquement à la page 121.
• Ajout de marqueurs aux plans: ajoutez des marqueurs pour baliser des points de références 
spécifiques dans un clip audio. Pour en savoir plus, consultez Présentation des marqueurs à la 
page 156.
• Application d’un trim à l’audio : réalisez des montages précis sur la forme d’onde audio, par 
exemple pour supprimer un son indésirable de l’enregistrement. Consultez Présentation du 
trim à la page 130.
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• Ajout de fondus enchaînés audio : créez une transition fluide reliant deux formes d’onde audio. 
Consultez Ajout de transitions au projet à la page 215.
• Utilisation de plans composés: les plans composés vous permettent de combiner n’importe 
quels plans vidéo ou clips audio en un seul plan ou clip composé. Du point de vue audio, les 
clips composés offrent la possibilité d’appliquer le même effet audio ou les mêmes améliorations à un groupe de clips, de façon analogue à l’application d’un effet ou d’un ajustement à 
l’ensemble d’un mixage. Consultez Présentation des plans composés à la page 266.
• Exportation de l’audio : vous pouvez exporter le projet sous forme de fichier audio mono, 
stéréo ou Surround. Vous pouvez également exporter des données en fonction de leur rôle. 
Consultez Présentation du partage de projets à la page 394.
Notions élémentaires sur le montage audio
À propos des formes d’onde audio
Les formes d’ondes audio constituent des représentations visuelles des sons. Elles s’affichent 
dans les clips audio des manières suivantes:
• dans la partie inférieure d’un plan vidéo, colorées en bleu ;
• sous forme de plans détachés ou de clips audio uniquement, colorés en vert.
Clip audio 
seulement
Section audio d’un 
plan vidéo
Leur amplitude et leur longueur varient selon le volume et la durée du son qu’elles représentent. 
Un son court et marqué, tel qu’un son de percussion, est représenté par une forme d’onde en 
pic, alors qu’un bruit de foule étouffé présente une forme d’onde plus basse et prolongée. Ces 
propriétés permettent de trouver plus facilement des points de montage spécifiques au moment 
d’appliquer un trim à des plans ou d’ajouter des images clés à des effets.
Dans Final Cut Pro, les formes d’onde varient en fonction du niveau de volume d’un plan ou clip 
ou des effets qui lui sont appliqués. Elles sont plus grandes lorsque le volume est élevé et plus 
petites lorsque ce dernier est faible.
Le montage de clips audio dans la timeline se fait tout d’abord en écoutant un plan lu ou survolé, puis en apportant des modifications au clip en utilisant la forme d’onde comme référence.
À propos des canaux audio et des composants audio
Les fichiers audio peuvent contenir un seul ou plusieurs canaux audio. Les canaux correspondent 
d’ordinaire aux entrées micro lors de l’enregistrement ou aux haut-parleurs pour la sortie multicanal. Par exemple, un fichier audio stéréo contient généralement les canaux gauche et droit correspondant ce qui est audible pendant la lecture dans les haut-parleurs de gauche et de droite.Chapitre 9 Montage audio 166
Final Cut Pro regroupe automatiquement les canaux en composants audio en fonction de la 
configuration des canaux pour le plan. Vous pouvez développer la partie audio de plans pour 
afficher et monter des composants audio jusqu’au niveau des différents canaux. Vous pouvez 
ensuite affiner le volume et la balance séparément ou appliquer et animer avec des images clés 
différents effets audio pour chaque composant. Pour en savoir plus, consultez Vue d’ensemble du 
montage audio à la page 175.
Le nombre de composants audio que vous pouvez voir correspond au nombre de canaux que 
vous avez configuré dans votre plan source.
Remarque : De nombreux formats courants de fichier audio numérique, tels que l’AAC et le MP3, 
utilisent des fichiers de stéréo entrelacée, lesquels ne contiennent pas de canaux gauche et droit 
distincts. Un clip stéréo présentant des canaux gauche et droit entrelacés apparaît sous forme 
de composant audio simple dans l’inspecteur audio et dans la timeline. Si vous changez la configuration des canaux du clip de Stéréo à Mono dual, les canaux apparaissent alors comme deux 
composants audio distincts.
Composants audio
Pour en savoir plus sur la configuration des canaux audio, consultez Configuration des canaux 
audio à la page 176.
Différentes manières d’afficher des clips audio
Lorsque vous travaillez avec des formes d’onde audio dans la timeline, vous pouvez réaliser des 
zooms avant ou arrière ou modifier l’apparence du plan pour agrandir ou réduire la forme d’onde.
Final Cut Pro comprend aussi plusieurs manières d’afficher et de travailler avec l’audio et la vidéo 
à l’intérieur des plans. Vous pouvez : 
• développer un plan de sorte à afficher et monter des composants audio jusqu’au niveau des 
différents canaux ;
• développer un plan pour afficher séparément l’audio et vidéo ;
• détacher l’audio d’un plan vidéo pour travailler sur l’audio et la vidéo séparément ;
• changer l’apparence de l’arrière-plan d’un plan pour afficher la forme d’onde de référence, ce 
qui facilite la visualisation de formes d’ondes audio lorsque le volume est réduit.
Affichage de composants audio développés
Vous pouvez développer la partie audio de plans dans Final Cut Pro pour afficher et modifier des 
composants audio.
Vous pouvez afficher les composants audio dans leur forme développée pour les plans synchronisés, les plans multicam et les plans composés.Chapitre 9 Montage audio 167
Procédez de l’une des manières suivantes:
m Sélectionnez le plan dans la timeline, puis choisissez Plan > Développer les composants audio 
(ou appuyez sur Option + Contrôle + S).
m Tout en maintenant la touche Option enfoncée, double-cliquez sur la partie audio du plan dans 
la timeline.
Vue du plan normal
Composants audio
Réduction des composants audio
Procédez de l’une des manières suivantes:
m Sélectionnez soit le plan ou l’un de ses composants audio dans la timeline, puis choisissez Plan > 
Réduire les composants audio (ou appuyez sur Option + Contrôle + S).
m Tout en maintenant la touche Option enfoncée, double-cliquez sur l’un des composants audio 
dans la timeline.
Affichage étendu de l’audio et de la vidéo
Vous pouvez afficher séparément l’audio et la vidéo d’un même plan dans la timeline en développant les plans qui contiennent de l’audio et de la vidéo. Cela peut s’avérer utile si vous devez 
zoomer sur des sections audio et réaliser des montages.
Remarque : Si vous créez un montage scindé de manière à ce que des sections audio se chevauchent, vous ne verrez clairement les formes d’onde se superposant que si vous choisissez 
d’afficher l’audio étendu pour les plans scindés.
m Pour développer un seul plan : double-cliquez sur la forme d’onde audio du plan.
m Pour développer un ou plusieurs plans sélectionnés dans la timeline : choisissez Plan > Développer 
l’audio/la vidéo (ou appuyez sur Contrôle + S).Chapitre 9 Montage audio 168
m Pour développer tous les plans dans la timeline : choisissez Présentation > Développer les plans 
audio/vidéo, puis indiquez si vous souhaitez développer l’audio/la vidéo pour tous les plans ou 
uniquement pour les plans qui se chevauchent.
Vue du plan normal
Plan avec audio étendu
En affichant l’audio étendu, les sections audio et vidéo du plan restent liées. Pour créer un plan 
audio connecté à part, détachez l’audio. Vous pouvez aussi utiliser l’éditeur de précision pour afficher une vue détachée des sections audio et vidéo du plan.
Condensation de l’affichage de l’audio et de la vidéo
Vous pouvez réduire la présentation développée de l’audio/la vidéo pour un seul plan, plusieurs 
plans ou tous les plans de la timeline.
m Pour réduire un seul plan : double-cliquez sur la forme d’onde audio du plan.
m Pour réduire un ou plusieurs plans sélectionnés dans la timeline : choisissez Plan > Condenser l’audio/la vidéo (ou appuyez sur Contrôle + S).
m Pour réduire tous les plans dans la timeline : choisissez Présentation > Condenser tous les plans.
Détachement de l’audio de la vidéo
Par défaut, Final Cut Pro importe l’audio et la vidéo provenant de la même source sous forme 
d’un seul plan. Il est facile de détacher l’audio d’un plan vidéo afin de pouvoir réaliser le montage du clip audio séparément dans la timeline.
m Sélectionnez le plan dans la timeline, puis choisissez Plan > Détacher l’audio.Chapitre 9 Montage audio 169
 Un nouveau clip audio s’affiche comme clip connecté sous le plan vidéo.
Audio dissocié
Pour rattacher un clip audio au plan vidéo original, vous devez créer un plan composé. 
Affichage ou masquage des formes d’onde de référence
Une forme d’onde de référence affiche la résolution maximale de la forme d’onde audio active. 
En faisant appel à un facteur d’annulation sur la tonalité, les formes d’onde de référence permettent de distinguer plus clairement les détails du son.
1 Choisissez Final Cut Pro > Préférences, puis cliquez sur Montage.
2 Cochez la case « Afficher les formes d’onde de référence ».
Forme d’onde de 
référence
Lorsque la forme d’onde active change de forme (par exemple, se réduit lorsque le volume d’un 
plan est faible), sa forme d’onde de référence reste visible pour faciliter le montage.
Conseil : Vous pouvez placer tout plan contenant de l’audio au-dessus ou en dessous du scénario principal dans la timeline. Si votre plan contient de la vidéo et qu’il est placé sous le scénario 
principal, il se peut que la vidéo soit masquée par celle dans le scénario principal, mais l’audio est 
lu. Si vous placez le plan au-dessus du scénario principal, l’audio est reproduit et la vidéo est lue 
(au lieu de celle du scénario principal).
Affichage des formes d’onde audio au niveau de l’échantillon audio
Pour réaliser un montage plus précis, vous pouvez effectuer des zooms dans les clips audio au 
niveau des échantillons audio. Les échantillons audio présentent la forme d’onde audio à une 
fraction de seconde (par exemple, 1/48 000 pour l’audio enregistré à une fréquence d’échantillonnage de 48 kHz). Le montage avec une précision à l’échantillon près n’est disponible que pour 
les clips audio connectés (c’est-à-dire les clips audio ne faisant pas partie du scénario principal) 
ou les plans composés ne contenant que de l’audio.Chapitre 9 Montage audio 170
Conseil : Lorsque vous travaillez sur de la vidéo, vous pouvez vous baser sur les sous-images 
(1/80 de la durée d’une image vidéo) dans l’affichage du timecode du panneau de contrôle. Dans 
la fenêtre Montage des préférences de Final Cut Pro, choisissez l’option de sous-image dans le 
menu local Affichage du temps.
Zoom sur les échantillons audio
1 Choisissez Présentation > Zoom sur les échantillons (ou appuyez sur Option + Z).
2 Sélectionnez le plan dans la timeline.
3 Réalisez un zoom avant jusqu’à ce que le plan affiche la forme d’onde à l’intérieur des bordures 
d’une image vidéo.
Bords d’image
Vous pouvez continuer le zoom avant pour afficher plus en détail la forme d’onde.
Bords d’image
4 Procédez aux montages du plan ou des ajustements aux effets audio à l’aide d’images clés.
Pour désactiver le zoom sur les échantillons, choisissez Présentation > Zoom sur les échantillons 
(ou appuyez sur Option + Z).
Navigation sous-image par sous-image
1 Dans la timeline ou le navigateur d’événements, placez votre pointeur sur un plan et cliquez.
2 Effectuez l’une des opérations suivantes:
• Pour reculer par incréments d’une sous-image : appuyez sur Commande + Flèche gauche.
• Pour avancer par incréments d’une sous-image : appuyez sur Commande + Flèche droite.
Affichage et correction des niveaux audio
Les VU-mètres audio vous permettent d’afficher et d’effectuer le suivi des niveaux audio des 
plans et clips dans Final Cut Pro. Ils vous avertissent si un plan particulier ou une section d’un 
plan atteint le niveau des crêtes, ce qui peut entraîner une distorsion audible.
Le nombre de VU-mètres affichés varie en fonction du nombre de canaux configurés pour le plan 
en cours de lecture. Par exemple, lorsque vous lisez un plan surround dans le navigateur d'événements, six VU-mètres surround sont affichés. Par contre, si vous faites glisser le même plan dans 
un projet stéréo dans la timeline, Final Cut Pro modifie l'audio pour passer de surround à stéréo 
et seulement deux VU-mètres sont affichés. Pour en savoir plus, consultez Configuration des 
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Lorsque le volume d’un clip audio s’approche des niveaux de crête au cours de la lecture, la couleur du niveau passe de vert à jaune.
Lorsqu’un clip audio dépasse ces niveaux de crête, la couleur du niveau passe de jaune à rouge 
et les témoins lumineux de crête deviennent rouges pour le ou les canaux audio concernés. Les 
indicateurs de crête se réinitialisent lorsque vous arrêtez et reprenez la lecture. 
Réglez le volume de façon à éviter que le volume d’un clip dépasse les niveaux de crête. Bien 
que le niveau adéquat pour un clip varie en fonction du mixage général désiré, il est important 
de vous assurer que le niveau combiné de tous les clips ne dépasse pas 0 dB.
Final Cut Pro comprend deux VU-mètres, un petit dans le panneau de contrôle de la barre d’outils et un plus grand dans la fenêtre des VU-mètres.
Afficher ou masquer les VU-mètres audio
Pour afficher les VU-mètres, procédez de l’une des façons suivantes:
m Choisissez Fenêtre > Afficher les VU-mètres.
m Cliquez sur l’icône VU-mètre dans le panneau de contrôle de la barre d’outils.
Vous pouvez faire glisser les bords des VU-mètres pour afficher une présentation développée 
contenant des informations supplémentaires.
Niveau 
Canaux Surround
Indicateurs de crête
Pour masquer les VU-mètres, choisissez Fenêtre > Masquer les VU-mètres audio, ou cliquez sur 
l’icône VU-mètre dans le panneau de contrôle de la barre d’outils.
Réinitialisation et correction les niveaux de crête
m Sélectionnez le plan dans la timeline, réajustez le niveau, puis relancez la lecture du plan pour 
vous assurer que les crêtes ont disparu.
Dans la timeline et le navigateur d’événements, la ou les sections de forme d’onde d’un plan 
deviennent jaunes lorsqu’un niveau se rapproche des niveaux de crête ou rouges lorsqu’un 
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Isolement et désactivation des clips audio
La fonctionnalité Solo permet de désactiver temporairement la lecture audio de tous les plans 
dans la timeline, excepté ceux que vous avez sélectionnés. Cela est particulièrement utile lors du 
montage audio si vous disposez de plusieurs clips audio dans la timeline (dialogue et musique 
de fond, par exemple) et que vous ne souhaitez écouter et modifier que certains clips.
Vous pouvez également désactiver le son des clips en les désactivant ces derniers. Les plans 
désactivés sont invisibles, silencieux et n’apparaissent dans aucune sortie.
Solo des plans dans la timeline
1 Sélectionnez un ou plusieurs plans dans la timeline.
2 Procédez de l’une des manières suivantes:
• choisissez Plan > Solo (ou appuyez sur les touches Option + S).
• Cliquez sur le bouton Solo dans la timeline.
Bouton Solo
Le plan placé en solo s’affiche en surbrillance alors que les autres apparaissent estompés.
Plan lu en solo
Pour désactiver le solo, cliquez sur le bouton Solo ou choisissez Plan > Solo (ou appuyez sur 
Option + S) à nouveau.
Désactivation de plans
1 Sélectionnez un ou plusieurs plans dans la timeline.
Remarque : Si les plans sélectionnés contiennent de l'audio et de la vidéo et que vous souhaitez 
désactiver le son de l'audio uniquement, choisissez Plan > Détacher l'audio et sélectionner uniquement la portion de l'audio détachée.
2 Choisissez Plan > Désactiver (ou appuyez sur la touche V).
Les clips désactivés sont muets et apparaissent estompés dans la timeline.
3 Pour réactiver les clips désactivés, sélectionnez-les dans la timeline et choisissez Plan > 
Désactiver (ou appuyez sur la touche V).
Vous pouvez mettre en solo des plans vidéo dans Final Cut Pro. Pour en savoir plus, consultez 
Isolement, désactivation et activation de plans à la page 123.Chapitre 9 Montage audio 173
Ajout de l’audio
Ajout de la musique et du son
Vous pouvez ajouter à votre projet de la musique et des fichiers son directement depuis votre 
bibliothèque iTunes ou d’autres sources.
Final Cut Pro inclut également un certain nombre de bruitages et d’autres effets sonores que 
vous pouvez utiliser comme clips audio connectés.
Si un plan contient de l’audio et de la vidéo, vous avez la possibilité de régler le mode de montage sur audio uniquement pour n’insérer que la partie audio du plan.
Ajout de musique et de son à un projet dans la timeline
1 Cliquez sur le bouton Musique et son dans la barre d’outils.
2 Dans le navigateur de musique et son, choisissez un dossier source dans le menu local situé en 
haut. Par exemple, choisissez iTunes pour parcourir votre collection iTunes.
Conseil : Si le dossier que vous recherchez n’est pas visible, vous pouvez l’ajouter à la liste 
de sources en le faisant glisser depuis le Finder ou le bureau jusque dans le navigateur de 
musique et son.
3 Dans la liste de sons qui s’affiche, recherchez le son ou la musique que vous désirez :
• Pour rechercher un élément: saisissez votre texte dans le champ de recherche. Pour filtrer votre 
recherche, cliquez sur le bouton Filtre et choisissez le filtre souhaité.
• Pour obtenir un aperçu d’un élément: double-cliquez sur l’élément ou sélectionnez-le et cliquez 
sur le bouton Lecture .
• Pour sélectionner plusieurs éléments: cliquez sur chaque élément tout en maintenant la touche 
Commande enfoncée.
4 Faites glisser le ou les fichiers de son vers la timeline.
Remarque : Pour de meilleures performances en lecture et à l’importation, Final Cut Pro transcode automatiquement tous les fichiers audio MP3 en fichiers audio WAV et conserve les fichiers 
MP3 originaux pour une utilisation ultérieure. Pour en savoir plus sur l’emplacement des fichiers 
de données originaux et des fichiers de données transcodés, consultez la section Emplacement 
de vos fichiers de média et de projet à la page 407.
Enregistrement de l’audio
Vous pouvez réaliser des enregistrements audio directement dans Final Cut Pro à partir de 
sources d’entrée telles que des micros intégrés et externes. Les fichiers audio enregistrés s’affichent dans le navigateur d’événements et sous forme de plans connectés dans la timeline.
Cette fonctionnalité est particulièrement utile pour l’enregistrement de narration en voix off.
Enregistrement de l’audio en direct
1 Placez la tête de lecture à l’endroit où vous souhaitez commencer l’enregistrement dans 
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2 Choisissez Fenêtre > Enregistrer l’audio.
Cliquez sur le bouton Enregistrement 
pour lancer ou interrompre 
l’enregistrement.
3 Si nécessaire, ajustez les paramètres d’entrée en procédant de l’une des manières suivantes:
• Pour modifier l’emplacement auquel l’enregistrement est sauvegardé : choisissez un dossier d’évé-
nement dans le menu local Destination.
• Pour modifier le dispositif d’entrée ou le nombre de canaux d’entrée (mono ou stéréo): choisissez 
une option dans le menu local Appareil d’entrée.
• Pour ajuster le niveau d’entrée du micro : faites glisser le curseur Gain vers la droite pour augmenter le niveau d’entrée ou vers la gauche pour le diminuer, en utilisant les VU-mètres pour 
contrôler et corriger les niveaux audio.
4 Si nécessaire, ajustez les paramètres de sortie en procédant de l’une des manières suivantes:
• Pour écouter la sortie lors de l’enregistrement: cochez la case Contrôle.
Remarque : Si les sources d’entrée et de sortie sont proches l’une de l’autre (comme dans le 
cas de micro et de haut-parleurs intégrés), un effet Larsen risque de se produire.
• Pour modifier le dispositif de sortie ou le nombre de canaux de sortie (mono ou stéréo): Choisissez 
une option dans le menu local Contrôle.
• Pour ajuster le niveau de sortie : faites glisser le curseur Gain vers la droite pour augmenter le 
niveau de sortie ou vers la gauche pour le diminuer.
5 Pour démarrer l’enregistrement, cliquez sur le bouton Enregistrer.
6 Pour arrêter l’enregistrement, cliquez à nouveau sur le bouton Enregistrer (ou appuyez sur la 
barre d’espace).
Vos enregistrements audio sont alors connectés au scénario principal au niveau de la tête 
de lecture.Chapitre 9 Montage audio 175
Modification de clips audio ou de composants audio
Vue d’ensemble du montage audio
Pour monter de l’audio dans Final Cut Pro, suivez l’une des deux façons détaillées ci-dessous.
Montage audio au niveau des plans
Vous pouvez procéder à des réglages et à des montages sur des plans entiers. À ce niveau, les 
réglages et les effets audio s’appliquent à l’intégralité du plan, y compris à tous les canaux audio 
inclus dans le plan. Final Cut Pro conserve tous les réglages que vous appliquez aux différents 
canaux audio. En d’autres termes, si vous réduisez le volume pour un seul canal mais que vous 
l’augmentez pour le plan entier, le volume du canal en question est également augmenté mais 
en respectant la proportion du volume des autres canaux du plan.
Si votre média source ne contient qu’un ou deux canaux audio ou si vous montez un plan ne 
contenant que de l’audio (clip audio), vous n’aurez probablement besoin que de procéder aux 
réglages et aux montages à ce niveau.
Montage audio multicanal avancé
Final Cut Pro regroupe automatiquement les canaux en composants audio en fonction de la 
configuration des canaux pour le plan. Vous pouvez développer la partie audio de plans pour 
afficher et monter des composants audio jusqu’au niveau des différents canaux. Cela vous 
permet d’appliquer différents effets à divers composants et de rationaliser le processus d’application d’estampes de son rapides à une seule entrée micro ou autres réglages plus fins.
Important : De nombreux formats de fichier audio numérique, tels que l’AAC et le MP3, utilisent 
des fichiers de stéréo entrelacée, lesquels ne contiennent pas de canaux gauche et droit distincts. 
Ces fichiers apparaissent sous forme d’un seul composant audio à moins que vous ne modifiiez 
la configuration des canaux du clip.
Gardez à l’esprit les points suivants lors du montage de composants audio dans Final Cut Pro : 
• Vous pouvez visualiser et modifier la configuration des canaux audio de vos plans dans 
l’inspecteur audio. Vous pouvez changer le nom des composants audio, en ajouter ou supprimer, mais aussi configurer les canaux aux formats mono, stéréo et Surround. Consultez 
Configuration des canaux audio à la page 176.
• À l’aide de l’outil Sélection de plage (outil d’édition par défaut), il vous est possible de sélectionner les plages dans un composant audio pour cibler l’audio à modifier.
• Vous pouvez monter des composants audio pour les plans synchronisés, les plans multicam et 
les plans composés.
• Pour modifier des composants audio, vous pouvez procéder de la même façon que pour les 
plans entiers. Vous pouvez :
• survoler des composants précis lorsque les survols de plan et audio sont activés. Consultez 
Survol du média à la page 81.
• ajuster le volume d’un composant. Consultez Ajustement du volume à la page 179.
• désactiver l’audio d’un composant en désactivant ce dernier partiellement ou dans son inté-
gralité. Il s’agit de la méthode la plus rapide pour supprimer des sons indésirables d’un composant. Consultez Isolement, désactivation et activation de plans à la page 123.
• effectuer la balance du son pour différents composants. Consultez Balance audio à la 
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• Attribuer un rôle, tel que Dialogue, Musique ou Effets, à un composant dans l’inspecteur 
d’informations (ou via le menu Modifier lorsque le plan contenant le composant audio se 
trouve dans la timeline). Consultez Utilisation de rôles pour organiser des plans et exporter 
des fichiers audio à la page 193.
• ajouter ou régler les effets audio de composants précis. Consultez Ajout d’effets audio à la 
page 194 ou Ajustement des effets audio à la page 196.
• régler les effets audio de composants précis à l’aide d’images clés. Consultez Ajustement des 
effets audio à l’aide d’images clés à la page 200.
Pour voir des exemples de flux de travail de montage audio multicanal, consultez Exemples de 
montage audio multicanal à la page 187.
Configuration des canaux audio
Final Cut Pro assigne une configuration de canaux par défaut aux clips audio lorsque ceux-ci sont 
importés ou ajoutés à un projet. Il vous est possible de modifier la configuration des canaux, par 
exemple, si vous souhaitez convertir un clip de dialogue stéréo en deux canaux mono.
Final Cut Pro regroupe automatiquement les canaux en composants audio en fonction de la 
configuration des canaux pour le plan. Pour en savoir plus, consultez À propos des canaux audio 
et des composants audio à la page 165.
En plus de modifier la configuration des canaux, vous pouvez aussi afficher et écouter les composants audio, en ajouter ou en supprimer et les renommer.
Modification de la configuration des canaux
Le nombre d’options que vous pouvez configurer dépend du nombre de canaux présents dans 
votre plan source ou votre plan composé. Vous pouvez configurer les canaux dans plusieurs formats, notamment :
• Mono : un seul canal. Dans une configuration de son Surround, vous pouvez affecter un canal 
mono à n’importe quel canal Surround.
• Stéréo : canaux gauche et droit.
• Surround 5.1 : canaux gauche, central, droit, Surround gauche, Surround droit et effets basse 
fréquence (caisson de basse).
• Surround 7.1 : canaux gauche, central, droit, Surround gauche, Surround droit, arrière gauche, 
arrière droit et effets basse fréquence (caisson de basse).
Si vous configurez plus de six canaux Surround, Final Cut Pro ajuste automatiquement le mixage 
des canaux pour obtenir une configuration Surround 5.1 pendant la lecture.
Important : La modification de la configuration des canaux réinitialise tous les réglages et les 
montages effectués sur les composants audio (notamment les effets appliqués, les plages désactivées, les réglages d’images clés et les noms personnalisés).
1 Sélectionnez le plan dans la timeline.
2 Dans la section Configuration des canaux de l’inspecteur audio, sélectionnez une option dans le 
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Les canaux apparaissent dans l’inspecteur audio sous forme de composants audio, chacun avec 
sa propre forme d’onde.
Si vous avez un plan incluant des canaux Surround et comptez attribuer un canal mono à un 
canal Surround particulier, sélectionnez la forme d’onde du canal mono, puis choisissez un canal 
Surround dans le menu local Canaux.
Remarque : Pour modifier la configuration des canaux d’un plan composé, désélectionnez tout 
d’abord l’option « Utiliser la présentation Plan de l’événement » dans le menu local Canaux, puis 
choisissez une autre configuration.
Pour réinitialiser une configuration, cliquez sur le bouton Réinitialiser .
Affichage et écoute d’un composant audio
1 Sélectionnez le plan dans la timeline.
2 Dans la section Configuration des canaux de l’inspecteur audio, cliquez sur le triangle d’affichage 
en regard du nom du plan pour révéler ses composants audio, puis effectuez le survol ou lancez 
la lecture de l’un d’entre eux à l’aide de la barre d’espace ou des touchesJ, K et L. 
Faites défiler pour 
prévisualiser.
Ajout ou suppression d’un composant audio
Vous pouvez ajouter ou supprimer des composants audio d’un plan. Par exemple, il peut s’avérer 
judicieux de supprimer les composants inutilisés d’un plan ou d’ajouter des composants tirés 
d’angles inactifs à l’angle actif dans un plan multicam.
Par défaut, tous les composants audio actifs dans un plan apparaissent sélectionnés dans l’inspecteur audio. Ils sont repris dans le même ordre lorsque le plan est développé pour afficher 
les composants audio dans la timeline. Pour en savoir plus sur l’affichage de composants audio, 
consultez Différentes manières d’afficher des clips audio à la page 166.Chapitre 9 Montage audio 178
Lorsque vous supprimez un composant audio, celui-ci est estompé dans l’inspecteur audio mais 
est supprimé de l’agencement des composants du plan dans la timeline.
1 Sélectionnez le plan dans la timeline.
2 Dans la section Configuration des canaux de l’inspecteur audio, cliquez sur le triangle d’affichage 
en regard du nom du plan pour révéler ses composants audio.
3 Procédez de l’une des manières suivantes:
• Pour supprimer un composant: décochez la case en regard de la forme d’onde d’un composant.
• Pour ajouter un composant: cochez la case en regard de la forme d’onde d’un composant.
Sélectionnez pour ajouter ou 
supprimer un composant audio.
Réattribution du nom d’un composant
Procédez de l’une des manières suivantes:
m Dans la section Configuration des canaux de l’inspecteur audio : cliquez sur le triangle d’affichage 
en regard du nom du plan pour révéler ses composants audio, double-cliquez sur le nom de 
celui à renommer, puis saisissez un nouveau nom.
Attribuez un nouveau 
nom au composant 
audio dans le champ.
m Dans un plan repris dans la timeline, avec ses composants audio développés: cliquez sur le composant audio tout en maintenant la touche Contrôle enfoncée, puis choisissez Renommer le composant dans le menu contextuel et saisissez un nouveau nom.
Pour en savoir plus sur l’affichage de composants audio, consultez Différentes manières d’afficher 
des clips audio à la page 166.
Important : Si vous modifiez par la suite la configuration des canaux, tous les noms personnalisés 
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Vous pouvez aussi choisir une configuration de canaux lorsque vous exportez des rôles sous 
forme de stems audio pour le mixage ou la postproduction. Pour en savoir plus, consultez 
Utilisation de rôles pour organiser des plans et exporter des fichiers audio à la page 193. Si la 
configuration de canaux choisie pour des fichiers exportés est différente de celle des fichiers 
source, les canaux sont exportés de la manière suivante :
• Source stéréo exportée en Surround : les canaux de gauche et de droite sont exportés dans les 
canaux de gauche et de droite du fichier Surround.
• Source Surround exportée en stéréo : la source Surround est exportée en tant que mix stéréo 
(canaux gauche et droite).
• Source stéréo ou Surround exportée en mono : la source stéréo ou Surround est exportée en tant 
que mix mono (un seul canal).
Ajustement du volume
Vous pouvez ajuster les niveaux de volume des clips audio depuis le navigateur d’événements, la 
timeline, l’inspecteur audio ou le menu Modifier. Les réglages de volume que vous réalisez dans 
l’inspecteur audio ou le menu Modifier s’appliquent à toute la sélection. Pour effectuer des ajustements plus précis, vous pouvez créer des images clés dans le clip, puis ajuster les points entre 
les images clés. Consultez Ajustement des effets audio à l’aide d’images clés à la page 200.
Vous pouvez utiliser les VU-mètres pour vous assurer que le volume ne dépasse pas les crêtes, ce 
qui pourrait entraîner une distorsion notable du son.
Ajustement du volume dans la timeline
m Faites glisser verticalement la commande du volume (la ligne horizontale qui traverse la forme 
d’onde audio).
Ce faisant, le niveau de décibels s’affiche et la forme d’onde change en fonction de 
vos ajustements.
Contrôle du 
volume
Si vous ajustez le volume entre deux images clés, les variations de la ligne de volume s’adaptent, 
traduisant les changements de volume entre les images clés.
Ajustement du volume à l’aide du menu Modifier ou du clavier
1 Sélectionnez un ou plusieurs clips audio ou plans vidéo contenant de l’audio dans la timeline.
2 Choisissez Modifier > Volume, puis sélectionnez Vers le haut ou Vers le bas, ou appuyez sur 
Contrôle + signe égal (=) ou sur Contrôle +Tiret (-).
Le volume est augmenté ou réduit de 1 dB. Si plusieurs clips ou plans sont sélectionnés, le 
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Ajustement du volume dans l’inspecteur audio
1 Sélectionnez un ou plusieurs clips audio ou plans vidéo contenant de l’audio dans le navigateur 
d’événements ou la timeline.
2 Dans l’inspecteur audio, procédez de l’une des façons suivantes:
• Saisissez une valeur dans le champ Volume.
Si plusieurs clips ou plans sont sélectionnés, le volume de chacun d’eux est réglé sur la 
valeur saisie.
• Faites glisser le curseur Volume vers la droite pour augmenter le volume ou vers la gauche 
pour le diminuer.
Si plusieurs clips ou plans sont sélectionnés, le volume de chacun d’eux est augmenté ou 
réduit par rapport à sa valeur d’origine.
Curseur de 
volume
Ajustement automatique du volume sur une zone sélectionnée
Pour ajuster le volume d’un plan de la timeline, vous pouvez utiliser l’outil Sélection de plage 
pour ajouter automatiquement des images clés sur une zone sélectionnée.
1 Sélectionnez le plan dans la timeline.
2 Choisissez Sélection de plage dans le menu local Outils de la barre d’outils (ou appuyez sur la 
touche R).
Le pointeur prend la forme de l’outil Sélection de plage . 
3 Faites glisser le pointeur sur la zone où vous voulez ajuster le volume.
4 Ajustez le volume de la plage en déplaçant verticalement la commande horizontale.
Les images clés sont automatiquement créées le long des points d’ajustement dans la plage.Chapitre 9 Montage audio 181
Réinitialisation de tous les réglages du volume
1 Sélectionnez un clip audio ou un plan vidéo contenant de l’audio dans le navigateur d’événements ou la timeline.
2 Cliquez sur le bouton Réinitialiser dans la section Volume et balance de l’inspecteur audio.
Application d’un fondu entrant ou sortant à l’audio
Il existe plusieurs moyens de créer des fondus entrants ou sortants dans la partie audio des plans 
dans Final Cut Pro :
• Fondus enchaînés automatiques durant les transitions : lorsque vous ajoutez une transition à un 
plan vidéo contenant de l’audio, Final Cut Pro applique automatiquement une transition en 
fondu enchaîné à la partie audio. Si l’audio est dissocié ou développé par rapport à la vidéo, 
la piste audio n’est alors pas affectée par la transition vidéo. Consultez Ajout de transitions au 
projet à la page 215.
• Fondus enchaînés: lors du trim de la forme d’onde audio dans des plans, il est possible d’appliquer un fondu enchaîné au point de montage. Consultez Présentation du trim à la page 130.
• Poignées de fondu : Vous pouvez créer rapidement des fondus entrants et sortants pour la portion audio des clips dans la timeline en utilisant les poignées de fondu qui s’affichent lorsque 
vous placez le pointeur sur le coin supérieur gauche ou droit d’une forme d’onde audio.
Poignée de fondu Poignée de fondu
Vous pouvez aussi modifier la forme du fondu en sélectionnant l’une des options prédéfinies. 
La modification de la forme du fondu change le son du fondu.
Remarque : les fondus créés au moyen de poignées de fondu sont prioritaires par rapport aux 
fondus enchaînés créés par des transitions.
Création d’un fondu à l’aide des poignées de fondu
m Faites glisser la poignée de fondu sur le point du plan où vous souhaitez que le fondu commence ou se termine.
Les poignées de fondu placées au début d’un plan créent un fondu entrant, tandis que celles 
placées à la fin d’un plan génèrent un fondu sortant.
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Les fondus complètent les ajustements de volume déjà effectués sur un clip audio. Par exemple, 
si vous avez auparavant baissé le volume au début d’un clip, le fondu entrant augmente le 
volume du silence (–∞ dB) jusqu’au niveau déjà spécifié.
Création manuelle d’un fondu enchaîné à l’aide des poignées de fondu
1 Sélectionnez les deux plans adjacents sur la timeline, puis choisissez Plan > Développer l’audio/la 
vidéo (ou appuyez sur Contrôle + S).
Les plans apparaissent alors sous leur forme développée.
2 Faites glisser le point d’arrivée du premier plan vers la droite et le point de départ du deuxième 
plan vers la gauche de sorte que les parties audio des plans se chevauchent.
Remarque : veillez à bien ajuster la superposition audio à la durée voulue.Chapitre 9 Montage audio 183
3 Faites glisser les poignées de fondu sur les points où vous souhaitez que le fondu commence et 
se termine.
Fondu enchaîné Poignée de fondu
Pour modifier la forme du fondu de chaque plan, suivez les instructions reprises immédiatement 
ci-dessous.
Changement de la forme d’un fondu à l’aide de poignées de fondu
m Cliquez sur une poignée de fondu en maintenant la touche Contrôle enfoncée, puis choisissez 
une option de fondu dans le menu contextuel :
• Linéaire : maintient une vitesse de changement constante sur toute la durée du fondu.
• Courbe S : atténuation en entrée et en sortie du fondu avec point intermédiaire à 0 dB.
• +3 dB : commence rapidement, puis ralentit progressivement vers la fin. Il s’agit du réglage le 
plus utile pour les fondus rapides.
• –3 dB : commence lentement, puis accélère vers la fin. Il s’agit du réglage par défaut, le plus 
adapté pour conserver un volume naturel lors de l’application d’un fondu croisé entre deux 
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Changement de la forme de fondu d’un fondu enchaîné de transition
1 Sélectionnez une transition dans la timeline, puis procédez de l’une des manières suivantes :
• Choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4).
• Dans la barre d’outils, cliquez sur le bouton Inspecteur.
2 Dans la section Fondu audio de l’inspecteur de transition, choisissez une option de fondu dans 
les menus locaux Type de fondu entrant et Type de fondu sortant :
• Linéaire : maintient une vitesse de changement constante sur toute la durée du fondu.
• Courbe S : atténuation en entrée et en sortie du fondu avec point intermédiaire à 0 dB.
• +3 dB : commence rapidement, puis ralentit progressivement vers la fin. Il s’agit du réglage le 
plus utile pour les fondus rapides.
• –3 dB : commence lentement, puis accélère vers la fin. Il s’agit du réglage par défaut, le plus 
adapté pour conserver un volume naturel lors de l’application d’un fondu croisé entre deux 
clips adjacents.
Balance audio
La balance audio vous permet de distribuer le son à travers le spectre stéréo ou Surround pour 
l’équilibrer ou générer un effet particulier. Par exemple, vous pouvez placer plus de son dans le 
canal droit d’un clip stéréo ou moins de son dans le canal central d’un clip Surround.
Final Cut Pro intègre un décodeur de son Surround permettant de choisir parmi plusieurs modes 
de préréglage de la balance stéréo et Surround que vous pouvez appliquer aux clips dans l’inspecteur audio. Les préréglages de balance vous permettent de recréer dynamiquement des 
champs sonores Surround à partir d’un contenu source stéréo.
Lorsque vous modifiez le mode de balance dans l’inspecteur audio, le réglage est appliqué à 
l’ensemble de la sélection. Pour réaliser des ajustements plus précis, vous pouvez ajouter des 
images clés à l’aide de l’éditeur d’animation audio ou de l’inspecteur audio, puis effectuer les 
ajustements nécessaires dans l’inspecteur audio.
Balance audio pour la stéréo
1 Sélectionnez le clip audio.
2 Dans l’inspecteur audio, choisissez Stéréo gauche/droite dans le menu local Mode de balance.
3 Déplacez le son vers la gauche ou la droite en effectuant l’une des opérations suivantes:
• Saisissez une valeur dans le champ Quantité de balance.
• Déplacez horizontalement le curseur Quantité de balance.
Balance audio pour le son Surround
1 Sélectionnez le clip audio.
2 Dans le menu local Mode de balance de l’inspecteur audio, choisissez l’une des options présentées ci-dessous:
• Créer de l’espace : distribue le signal à travers le spectre Surround, en concentrant le signal au 
centre et dans les canaux frontaux gauche et droit. Ce réglage est utile pour réaliser un mixage 
Surround général à partir de n’importe quelle source stéréo. La plage de réglage du curseur 
Quantité de balance s’étend de 0 (aucun effet) à 100 (champ Surround intégral).Chapitre 9 Montage audio 185
• Dialogue : concentre le signal dans le canal central du spectre Surround de sorte que le son 
direct se trouve au centre et que le son ambiant soit réparti entre les autres canaux. Ce réglage 
est idéal pour les voix off et les clips contenant des dialogues. La plage de réglage du curseur 
Quantité de balance s’étend de 0 (aucun effet) à 100 (tout le son concentré dans le canal 
central).
• Musique : répartit un signal stéréo mélangé sur tout le spectre Surround. Ce réglage est idéal 
pour convertir de la musique stéréo en un mixage Surround. La plage de réglage du curseur 
Quantité de balance s’étend de 0 (aucun effet) à 100 (champ Surround intégral).
• Ambiance : balayage du spectre Surround en concentrant le signal sur les canaux Surround et 
en réduisant le signal vers les canaux frontaux et centraux. Ce réglage est utile pour les effets 
tels que les bruits de foule ou les environnements extérieurs. La plage de réglage du curseur 
Quantité de balance s’étend de 0 (aucun effet) à 100 (champ Surround intégral).
• Cercle : balayage du son en cercle autour du spectre Surround comme une abeille tournant 
autour de la tête de l’auditeur. Le curseur Quantité de balance permet d’ajuster la direction par 
rapport à l’auditeur en degrés (-180 à 180).
• Rotation : balayage autour du spectre Surround comme si l’auditeur tournait en rond. Le curseur Quantité de balance permet d’ajuster la rotation de l’auditeur en degrés (-180 à 180).
• Retour vers l’avant: balayage de l’arrière vers l’avant à travers le spectre Surround. La plage de 
réglage du curseur Quantité de balance s’étend de -100 (arrière) à 100 (avant).
• Surround gauche vers avant droit: Balayage du Surround gauche vers l’avant droit à travers 
le spectre Surround. La plage de réglage du curseur Quantité de balance s’étend de -100 
(Surround gauche) à 100 (avant droit).
• Surround droit vers avant gauche : Balayage du Surround droit vers l’avant gauche à travers 
le spectre Surround. La plage de réglage du curseur Quantité de balance s’étend de -100 
(Surround droit) à 100 (avant gauche).
3 Pour ajuster la quantité de balance, effectuez l’une des opérations suivantes:
• Saisissez une valeur dans le champ Quantité de balance.
• Déplacez horizontalement le curseur Quantité de balance.
Les réglages Quantité de balance varient en fonction du mode de balance choisi.
Ajustement du son Surround à l’aide du panner Surround
Dans l’inspecteur audio, vous pouvez utiliser le panner Surround pour modifier le champ sonore 
Surround ou effectuer des ajustements avancés à l’aide des curseurs.
À l’aide du panner Surround, vous pouvez modifier les niveaux de balance en déplaçant une 
commande représentant l’origine apparente du son dans une configuration réelle de hautparleurs Surround.
1 Choisissez un préréglage Surround parmi ceux proposés dans le menu local Mode de balance.
2 Pour ouvrir le panner Surround, cliquez sur le triangle d’affichage en regard de l’élément dans la 
section Volume et balance de l’inspecteur audio.
Cliquez ici pour afficher le 
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3 Effectuez l’une des opérations suivantes:
• Pour effectuer des ajustements dans le panner Surround : faites glisser la commande dans le 
champ Surround pour déplacer la balance vers certains canaux Surround ou l’éloigner de 
ceux-ci (gauche, central, droit, Surround gauche ou Surround droit, représentés par des icônes 
de haut-parleur). Cliquez sur une icône de haut-parleur pour l’activer ou la désactiver.
Faites glisser pour 
déplacer la source 
sonore.
Pour ramener la commande à sa position centrale, double-cliquez dessus.
• Pour effectuer des ajustements avancés: cliquez sur le triangle d’affichage Avancé situé sous le 
panner Surround, puis faites glisser horizontalement les curseurs des paramètres suivants:
• Original/Décodé : règle la balance entre les signaux originaux et les signaux décodés. Le curseur peut être ajusté de –100 (signal original uniquement) à 100 (centre décodé et signaux 
Surround uniquement). À 0, le signal est équilibré de façon égale entre les signaux originaux 
et les signaux décodés.
• Ambient/Direct: règle la balance entre les signaux Surround décodés et les signaux centraux. Le curseur peut être ajusté de -100 (signal Surround uniquement) à 100 (signal central 
uniquement). À 0, le signal est équilibré de façon égale entre les signaux centraux et les 
signaux Surround.
• Largeur Surround : spécifie quelle valeur de séparation (exprimée en dB) existe entre les 
signaux Surround décodés. À 0 dB, il existe une séparation complète entre les signaux centraux et les signaux Surround, mais chaque signal Surround est mono. Pour accroître l’effet 
stéréo dans les canaux Surround gauche et droit, vous pouvez augmenter la valeur du paramètre. Cela aura également pour effet de dévier une partie du signal du canal central vers 
les canaux Surround.
• Balance LFE : ajuste les signaux des effets de fréquence faible (subwoofer) de -1 (aucun signal 
envoyé vers le canal LFE) à 1 (tous les signaux envoyés vers le canal LFE). Lorsque le curseur 
est centré sur 0, le signal est distribué de façon égale entre les cinq canaux et le canal LFE.
• Rotation : fait tourner tous les signaux Surround vers la gauche ou la droite de façon circulaire. Lorsque le curseur est placé à l’extrémité gauche ou droite (respectivement -180 degrés 
ou 180 degrés), le signal Surround tourne vers le canal central et le signal central tourne vers 
les canaux Surround. À 0 degré (curseur placé au centre), aucune rotation n’est effectuée.
• Répartition stéréo : règle la quantité d’effet stéréo des canaux gauche et droit vers les hautparleurs Surround et central.Chapitre 9 Montage audio 187
• Atténuer/Condenser: ajuste la façon dont l’effet de balance est mis en œuvre. À 0, les signaux 
source sont atténués (ce qui signifie que les signaux du canal original deviennent plus forts 
et plus doux mais ne sont pas réellement déviés vers d’autres canaux). À 100, les signaux 
source sont condensés (ce qui signifie que les signaux des canaux originaux ne sont pas 
modifiés en volume, mais plutôt qu’ils sont déplacés vers d’autres canaux dans la direction 
de la balance).
• Balance au centre : règle la balance entre les signaux centraux et les signaux Surround. Le 
curseur peut être réglé de -100 (tous les signaux centraux envoyés vers les canaux Surround) 
à 100 (tous les signaux Surround envoyés vers le canal central). À 0, le signal est équilibré de 
façon égale entre les canaux centraux et les canaux Surround.
Lorsque vous ajustez les paramètres avancés, le mode de balance indique qu’il a été modifié.
Réinitialisation des réglages de la balance
m Pour réinitialiser un mode de balance modifié : choisissez un autre préréglage dans le menu local 
Mode de balance. Le curseur Quantité de balance n’est pas affecté.
m Pour ne réinitialiser que les ajustements du panner Surround : cliquez sur le bouton Réinitialiser 
dans la section Panner Surround de l’inspecteur audio.
m Pour réinitialiser tous les réglages: cliquez sur le bouton Réinitialiser en haut de la section 
Volume et balance de l’inspecteur audio.
Vous pouvez contrôler les niveaux des canaux stéréo et son Surround à l’aide des 
Vu-mètres audio.
Exemples de montage audio multicanal
Les exemples ci-dessous traitent de flux de production pour le montage audio multicanal dans 
Final Cut Pro.
Exemple : Suppression de bruit indésirable d’un composant audio donné
Remarque : Pour effectuer le survol d’un composant audio particulier, assurez-vous que les survols de plan et audio sont tous deux activés. Pour en savoir plus, consultez Survol du média à la 
page 81.
1 Sélectionnez un plan dans la timeline, puis choisissez Plan > Développer les composants audio 
(ou appuyez sur Option + Contrôle + S).
Composants audio
2 Survolez ou lancez la lecture du composant audio pour rechercher l’emplacement spécifique où 
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3 Faites glisser le pointeur dans le composant pour sélectionner la plage où le bruit se produit.
4 Procédez de l’une des manières suivantes:
• Pour désactiver la partie du composant où le bruit se produit: appuyez sur la touche V (ou 
appuyez sur la touche Supprimer).
La désactivation d’une plage sélectionnée coupe tout son s’inscrivant dans la plage.
Remarque : Pour réactiver le son sur la plage, appuyez sur la touche V (ou appuyez sur 
Commande + Z).
• Pour ajuster le volume dans la plage choisie : faites glisser verticalement la 
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Les images clés sont automatiquement créées le long des points d’ajustement dans la plage.
5 Lancez la lecture du plan pour vérifier vos modifications à l’écoute.
6 Pour réduire les composants audio après avoir terminé vos réglages, choisissez Plan > Réduire les 
composants audio (ou appuyez sur Option + Contrôle + S).
Exemple : Trim audio dans un composant audio 
1 Sélectionnez un plan dans la timeline, puis choisissez Plan > Développer les composants audio 
(ou appuyez sur Option + Contrôle + S).
Composants audio
2 Positionnez le pointeur sur le bord du composant audio sur lequel effectuer un trim.
Le pointeur prend la forme de l’outil Trim .
3 Faites glisser pour effectuer le trim sur la section.
La section à laquelle est appliqué un trim est désactivée (coupant ainsi tous les sons de la section en question) et apparaît estompée dans la timeline.
Pour annuler votre trim, appuyez sur Commande + Z.Chapitre 9 Montage audio 190
4 Lancez la lecture du plan pour vérifier vos modifications à l’écoute.
5 Pour réduire les composants audio après avoir terminé vos réglages, choisissez Plan > Réduire les 
composants audio (ou appuyez sur Option + Contrôle + S).
Exemple : Application d’un montage Roll à tous les composants audio
1 Sélectionnez un plan dans la timeline, puis choisissez Plan > Développer les composants audio 
(ou appuyez sur Option + Contrôle + S).
Composants audio
2 Positionnez le pointeur sur le bord de la partie audio du plan auquel appliquer le montage.
Le pointeur prend la forme de l’outil Trim .
3 Maintenez la touche Maj enfoncée et faites glisser pour rembobiner le point de montage pour la 
partie audio du plan.
Le point de montage est déplacé sur le nouvel emplacement, coupant ainsi l’audio à la fin du 
plan. La partie vidéo du plan ne se voit pas affectée par cette modification.
Pour annuler votre montage, appuyez sur Commande + Z.
4 Lancez la lecture du plan pour vérifier vos modifications à l’écoute.
5 Pour réduire les composants audio après avoir terminé vos réglages, choisissez Plan > Réduire les 
composants audio (ou appuyez sur Option + Contrôle + S).
Exemple : ajout ou suppression des composants audio d’un plan multicam
Lorsque vous créez un plan multicam contenant plusieurs composants audio, vous pouvez faire 
appel au visualiseur d’angle ou à l’inspecteur audio pour ajouter à des angles actifs des composants audio tirés d’angles inactifs. Cela simplifie l’ajout d’audio de plusieurs plans source dans 
votre plan multicam tout en conservant l’angle vidéo actif. Il vous est également possible de supprimer des composants audio de l’angle actif afin d’éliminer de l’audio indésirable ou inutilisé.Chapitre 9 Montage audio 191
Avant de commencer, vous pouvez procéder à des réglages de la configuration des canaux des 
composants audio dans vos plans source repris dans le navigateur d’événements, à l’aide de l’inspecteur audio. Pour en savoir plus, consultez Configuration des canaux audio à la page 176.
1 Faites glisser un plan multicam du navigateur d’événements sur la timeline.
2 Pour ouvrir le visualiseur d’angle, procédez de l’une des manières suivantes:
• Choisissez Fenêtre > Affichage du visualiseur > Afficher les angles (ou appuyez sur 
Commande + Maj + 7).
• Choisissez « Afficher les angles » dans le menu local des options d’affichage du visualiseur 
situé dans le coin supérieur droit du visualiseur.
L’angle actif apparaît encadré en jaune.
Angle actif dans le 
visualiseur d’angle
3 Pour activer l’audio seulement dans le visualiseur d’angle, cliquez sur le bouton de droite de 
changement de mode situé dans le coin supérieur gauche.
Cliquez pour 
autoriser le passage 
à l’audio uniquement.
4 Pour ouvrir l’inspecteur audio, procédez de l’une des manières suivantes:
• Choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4), puis cliquez sur le 
bouton Audio situé en haut de la fenêtre Inspecteur.
• Cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le 
bouton Audio situé en haut de la fenêtre Inspecteur.
L’audio correspondant à l’angle actif dans le visualiseur d’angle apparaît en surbrillance dans 
la section Configuration des canaux de l’inspecteur audio.Chapitre 9 Montage audio 192
5 Pour révéler les composants audio de l’angle actif, cliquez sur le triangle d’affichage en regard du 
nom du plan source de l’angle actif. 
Cliquez pour afficher les composants 
audio pour l’angle actif.
6 Pour ajouter les composants audio d’angles inactifs, effectuez l’une des opérations suivantes:
• Dans le visualiseur d’angle : maintenez les touches Commande et Option enfoncées et cliquez 
sur un ou des angles inactifs.
• Dans l’inspecteur audio : cochez la case en regard de chaque composant audio à ajouter.
Dans cet exemple, l’angle dont vous avez ajouté l’audio est mis en surbrillance verte dans le 
visualiseur d’angle et les composants audio ajoutés sont indiqués dans l’inspecteur audio.
Composants audio ajoutés 
à l’angle actif
Composants audio ajoutés 
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Les composants audio ajoutés apparaissent également dans l’agencement des composants du 
plan multicam de la timeline. (Pour afficher les composants audio sous leur forme développée, 
choisissez Plan > Développer les composants audio, ou appuyez sur Option + Contrôle + S.)
Composants audio 
ajoutés à la timeline
7 Pour supprimer un composant audio de l’angle actif, effectuez l’une des opérations suivantes:
• Dans le visualiseur d’angle : Maintenez les touches Commande et Option enfoncées et cliquez 
sur l’angle (en surbrillance verte) dont vous souhaitez supprimer l’audio.
• Dans l’inspecteur audio : décochez la case en regard du composant audio à supprimer.
Une fois un composant supprimé, celui-ci est estompé dans l’inspecteur audio, et l’angle ne 
s’affiche plus en surbrillance verte dans le visualiseur d’angle. Le composant disparaît également 
de l’agencement des composants du plan multicam de la timeline.
Utilisation de rôles pour organiser des plans et exporter des fichiers audio
Final Cut Pro attribue un rôle audio (Dialogue, Musique ou Effets) à la partie audio des plans lors 
de l’importation.
Si la possibilité d’attribuer des rôles simplifie l’organisation des plans en fonction du type audio, 
son plus grand avantage réside toutefois dans la facilité avec laquelle vous pouvez exporter des 
fichiers séparés (appelés stems) depuis Final Cut Pro pour tous les plans d’effets, de musique 
et de dialogues. Ce processus est souvent utilisé lorsqu’il s’agit de livrer des fichiers correspondant à certaines spécifications de diffusion ou de remettre des stems en vue du mixage ou de 
la postproduction.
Vous pouvez utiliser des rôles pour les flux de production suivants:
• Réaffectation de rôles : Vous pouvez visualiser et réaffecter les rôles d’un plan dans l’index 
de la timeline, le navigateur d’événements, l’inspecteur d’informations ou le menu Modifier. 
Vous avez également la possibilité d’afficher et de réattribuer un rôle pour un composant 
audio dans l’inspecteur d’informations (ou via le menu Modifier lorsque son plan de ce composant se trouve dans la timeline). Consultez Affichage et réattribution de rôles à la page 311. 
Vous pouvez aussi créer des rôles et des sous-rôles personnalisés pour organiser davantage 
vos plans. 
• Afficher et organiser des plans en fonction du rôle : l’index de la timeline vous permet d’organiser 
des plans en fonction du rôle, d’activer ou de désactiver des rôles et de mettre des plans en 
surbrillance ou de les minimiser en vue de leur affichage dans la timeline. Vous pouvez par 
exemple identifier facilement tous vos plans de dialogue et les lire isolément par rapport aux 
autres plans audio. Consultez Affichage des plans en fonction du rôle dans la timeline à la 
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• Exporter des stems : Il est possible d’exporter des rôles sous forme de stems soit dans un fichier 
QuickTime multipiste combiné, soit dans des fichiers audio ou vidéo séparés. Durant le processus d’exportation, vous pouvez attribuer des sorties mono, stéréo ou Surround à vos canaux 
audio. Consultez Présentation du partage de projets à la page 394.
Ajout et ajustement d’effets audio
Ajout d’effets audio
Outre les fonctionnalités d’amélioration audio intégrées de Final Cut Pro, vous pouvez tirer 
profit des effets intégrés à OS X 64 bits et des effets Audio Units (AU) tiers pour vos tâches de 
traitement audio.
Final Cut Pro comprend aussi une large gamme d’effets audio personnalisés et d’effets Logic professionnels qui constituent des effets et des processeurs de traitement des signaux numériques 
utilisés pour colorer les enregistrements et les sources audio en temps réel ou faire adopter à 
leur tonalité une forme.
Parmi les options de traitement les plus courantes, on trouve la réduction du bruit, la correction 
de la tonalité, les égalisateurs, les processeurs dynamiques et les réverbérations. Il existe également des fonctionnalités avancées telles que les délais, les modulations, les distorsions, l’amé-
lioration des basses et les processeurs et utilitaires de modulation temporelle. Certains effets 
personnalisés compris dans Final Cut Pro combinent plusieurs effets de manière à créer un environnement sonore particulier, tel qu’une cathédrale.
Vous pouvez ajouter des effets à des plans ou clips précis ou à un plan composé. Après avoir 
ajouté un effet, il est possible d’en ajuster les réglages à l’aide de l’inspecteur audio.
Ajout d’effets audio à un plan ou clip
1 Dans la barre d’outils, cliquez sur le bouton Effets.
2 Dans le navigateur d’effets, sélectionnez un effet audio en vous aidant de l’un des éléments 
suivants:
• Pour obtenir un aperçu une fois l’effet appliqué à l’audio tiré du plan ou clip sélectionné dans la 
timeline : placez le pointeur sur les vignettes d’effets audio.
• Pour effectuer un preview influant sur la commande principale de l’effet: maintenez la touche 
Option enfoncée tout en plaçant le pointeur sur la vignette d’un effet audio.
• Pour filtrer la liste des effets qui apparaissent à l’écran : saisissez le texte recherché dans le champ 
de recherche du navigateur d’effets.
3 Procédez de l’une des manières suivantes:
• Faites glisser l’effet sur un clip audio (ou un plan vidéo contenant de l’audio) dans la timeline.
• Double-cliquez sur l’icône de l’effet pour l’appliquer au plan ou clip sélectionné.
L’effet s’affiche dans la section Effets de l’inspecteur audio et dans l’éditeur d’animation audio. 
Vous pouvez à présent ajuster l’effet.Chapitre 9 Montage audio 195
Désactivation d’un effet de plan
Lorsque vous appliquez un effet audio à un plan, il vous est possible de désactiver cet effet (tout 
en conservant ses réglages) dans l’inspecteur audio ou l’éditeur d’animation audio.
1 Sélectionnez dans la timeline un plan incluant un effet.
2 Procédez de l’une des manières suivantes:
• Dans la section Effets de l’inspecteur audio, sélectionnez l’effet et cliquez sur sa case bleue.
• Dans l’éditeur d’animation audio, sélectionnez l’effet et cliquez sur sa case verte.
Suppression d’un effet de plan
Lorsque vous appliquez un effet audio à un plan, il vous est possible de supprimer cet effet dans 
l’inspecteur audio ou l’éditeur d’animation audio.
1 Sélectionnez dans la timeline un plan incluant un effet.
2 Procédez de l’une des manières suivantes:
• Dans la section Effets de l’inspecteur audio, sélectionnez l’effet et appuyez sur la 
touche Supprimer.
• Dans l’éditeur d’animation audio, sélectionnez l’effet et appuyez sur la touche Supprimer.
Modification de l’ordre des effets
Lorsque vous appliquez des effets audio à un plan, il vous est possible de modifier l’ordre dans 
lequel ils apparaissent dans l’inspecteur audio ou l’éditeur d’animation audio.
1 Dans la timeline, sélectionnez un plan auquel vous avez ajouté des effets.
2 Procédez de l’une des manières suivantes:
• Dans la section Effets de l’inspecteur audio, faites glisser un effet vers le haut ou le bas.
• Dans l’éditeur d’animation audio, faites glisser un effet vers le haut ou le bas.
Copie de tous les effets d’un plan vers un autre
Vous pouvez copier les effets et leurs réglages d’un plan ou clip à un autre. Cela peut être particulièrement utile si vous avez réalisé des ajustements aux effets d’un plan que vous souhaitez 
conserver et utiliser pour d’autres plans. 
1 Sélectionnez un plan dans la timeline, puis choisissez Édition > Copier (ou appuyez sur 
Commande + C).
2 Sélectionnez le ou les plans auxquels vous souhaitez appliquer les effets, puis choisissez Édition > 
Coller les effets (ou appuyez sur Commande +Option +V).
Si plusieurs effets sont appliqués à un plan, l’ensemble de ceux-ci et leurs réglages 
sont appliqués.
Copie des attributs d’un plan sélectionné vers un autre
Il est possible de copier les attributs audio, tels que les réglages et les effets, d’un plan à l’autre. 
Par exemple, il vous est possible de copier les réglages de balance, ou tout autre effet ajouté à un 
plan, y compris des réglages d’image clé quelconques.
Cette fonctionnalité vous permet de sélectionner les attributs de plan à appliquer.
1 Sélectionnez un plan dans la timeline, puis choisissez Édition > Copier (ou appuyez sur 
Commande + C).
2 Sélectionnez le ou les plans auxquels vous souhaitez appliquer les attributs, puis choisissez 
Édition > Coller les attributs (ou appuyez sur Commande + Maj +V).Chapitre 9 Montage audio 196
3 Procédez de l’une des façons suivantes:
• Pour appliquer tous les attributs audio du plan source : cochez la case Attributs audio.
• Pour appliquer des attributs précis: cochez la case de chaque attribut à appliquer.
• Si vous avez apporté des réglages d’images clés au plan source : choisissez « Conserver le contrôle 
du temps » ou « Adapter par étirement » dans le menu local Images clés. Si vous choisissez 
Adapter par étirement, Final Cut Pro adapte les images clés dans le temps pour respecter la 
durée du plan de destination.
4 Cliquez sur Coller.
Pour en savoir plus sur l’utilisation des effets Logic inclus dans Final Cut Pro, consultez la page de 
référence des effets Logic de Final Cut Pro X : http://help.apple.com/finalcutpro-logiceffects/mac.
Ajustement des effets audio
Vous pouvez ajuster les paramètres d’un effet à l’aide des commandes de l’inspecteur audio ou 
de la fenêtre de l’effet.
Si vous utilisez des effets Audio Units ou Logic, vous pouvez afficher une interface développée en 
ouvrant la fenêtre de l’effet.
Pour en savoir plus sur l’utilisation des effets Logic inclus dans Final Cut Pro, consultez la page de 
référence des effets Logic de Final Cut Pro X : http://help.apple.com/finalcutpro-logiceffects/mac.Chapitre 9 Montage audio 197
Ajustement d’un effet audio
1 Sélectionnez dans la timeline un plan incluant un effet à adapter.
2 Localisez l’effet dans la section Effets de l’inspecteur audio.
Bouton d’accès aux 
commandes
3 Pour afficher les paramètres d’un effet, procédez de l’une des manières suivantes:
• Cliquez sur le bouton Commandes (à droite du nom de l’effet) pour afficher une fenêtre plus 
grande contenant des commandes avancées.
• Cliquez sur le triangle d’affichage en regard des paramètres pour afficher les commandes dans 
l’inspecteur audio.
Conseil : Vous pouvez ajuster les effets dans le temps à l’aide d’images clés dans l’inspecteur 
audio ou dans l’éditeur d’animation audio.
4 Sélectionnez les paramètres d’effets et ajustez leurs réglages selon vos besoins. Vous pouvez obtenir un aperçu de vos ajustements à l’aide du skimmer ou en reproduisant le clip dans la timeline.
Pour rétablir les valeurs par défaut des réglages des effets, cliquez sur le bouton Réinitialiser de 
l’effet.
Utilisation de préréglages d’effets
De nombreux effets Audio Units et Logic comportent des préréglages intégrés adaptés à certains 
réglages ou environnements spécifiques. C’est le cas par exemple des préréglages réverbération 
qui simulent l’ambiance acoustique d’une petite pièce ou d’une vaste cathédrale. Les préréglages 
facilitent la prévisualisation et l’application rapide d’effets.
1 Localisez l’effet dans la section Effets de l’inspecteur audio.
2 Sélectionnez un préréglage dans le menu local Préréglage.Chapitre 9 Montage audio 198
Vous pouvez obtenir un aperçu de vos préréglages en utilisant le skimmer ou en lisant le plan 
dans la timeline.
Pour rétablir les réglages par défaut de l’effet, choisissez Par défaut dans le menu 
local Préréglage.
Modification et enregistrement de préréglages personnalisés
Vous pouvez modifier des paramètres de préréglage en ajustant les commandes de l’effet. Pour 
conserver vos modifications, enregistrez-les en tant que préréglage personnalisé.
1 Localisez l’effet dans la section Effets de l’inspecteur audio.
2 Sélectionnez un préréglage dans le menu local Préréglage.
3 Pour afficher les paramètres d’un effet, procédez de l’une des manières suivantes:
• Cliquez sur le bouton Commandes (à droite du nom de l’effet) pour afficher une fenêtre plus 
grande contenant des commandes avancées.
• Cliquez sur le triangle d’affichage en regard des paramètres pour afficher les commandes dans 
l’inspecteur audio.
4 Sélectionnez les paramètres d’effets et ajustez leurs réglages selon vos besoins. Vous pouvez 
obtenir un aperçu de vos ajustements à l’aide du skimmer ou en reproduisant le clip dans 
la timeline.
Lorsque vous modifiez les paramètres d’un préréglage, le menu local Préréglage indique que le 
préréglage a été modifié.
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5 Pour enregistrer un préréglage modifié, choisissez Enregistrer ce préréglage dans le menu local 
Préréglage, puis saisissez un nom pour le nouveau préréglage.
Les préréglages enregistrés apparaissent dans le menu local Préréglage.
Pour rétablir les réglages par défaut de l’effet, choisissez Par défaut dans le menu 
local Préréglage.
Suppression de préréglages personnalisés
1 Localisez l’effet dans la section Effets de l’inspecteur audio.
2 Dans le menu local Préréglage, choisissez l’option Afficher les préréglages utilisateur dans 
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3 Sélectionnez le ou les préréglages à supprimer dans la fenêtre du Finder, puis faites-les glisser 
dans la corbeille.
Les préréglages personnalisés supprimés ne sont plus visibles dans le menu local Préréglage.
Ajustement des effets audio à l’aide d’images clés
Final Cut Pro vous permet d’utiliser des images clés pour créer de simples évolutions à l’audio 
dans le temps. Il est par exemple possible d’appliquer un fondu entrant ou sortant au volume ou 
à un effet au milieu du plan.
Il vous suffit de placer des images clés aux points spécifiques d’un plan ou clip pour modifier la 
valeur du paramètre d’une amélioration audio ou d’un effet appliqué à ces endroits. Par exemple, 
vous pouvez appliquer une image clé sur le volume ou sur un effet tel qu’une réverbération ou 
une distorsion.
Il est possible de définir des images clés pour ajuster le volume d’un plan directement dans la 
timeline ou dans l’inspecteur audio. Pour voir les images clés dans la timeline pour tous les autres 
effets, vous devez afficher l’éditeur d’animation audio.
Pour en savoir plus sur les images clés appliquées à des plans vidéo, consultez Ajustement d’effets vidéo à l’aide d’images clés à la page 256.
Ajout d’images clés à un plan
1 Procédez de l’une des manières suivantes:
• Sélectionnez le plan dans la timeline, puis choisissez Plan > Afficher l’animation audio (ou 
appuyez sur Contrôle + A).
• En maintenant la touche Contrôle enfoncée, cliquez sur le plan dans la timeline, puis choisissez 
« Afficher l’animation audio » dans le menu contextuel. 
Si vous ajoutez des images clés uniquement pour réaliser des réglages de volume, passez à 
l’étape 4.
Dans l’éditeur d’animation audio, chaque effet possède une zone séparée pour l’ajout 
d’images clés.
Certains effets possèdent plusieurs paramètres et vous permettent d’ajouter des images clés 
indépendamment aux différents paramètres. Ils apparaissent dans l’éditeur d’animation audio 
avec un triangle en regard du nom de l’effet et dans l’inspecteur audio sous forme de commandes de paramètre supplémentaires.
2 Sélectionnez l’effet auquel vous souhaitez ajouter des images clés dans l’éditeur d’animation 
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3 Procédez de l’une des manières suivantes:
• Pour développer les paramètres dans l’éditeur d’animation audio : cliquez sur le triangle pour 
choisir un paramètre précis dans le menu local, ou sélectionnez Tous pour voir toutes les 
images clés.
• Pour développer les paramètres dans l’inspecteur audio : Cliquez sur le triangle d’affichage situé 
en regard de Paramètres pour l’effet en question.
4 Procédez de l’une des manières suivantes pour chaque paramètre d’effet :
• Dans l’éditeur d’animation audio (ou le clip audio pour le volume uniquement): tout en maintenant la touche Option enfoncée, cliquez sur un point de la commande horizontale de l’effet où 
vous souhaitez ajouter l’image clé (ou appuyez sur Option + K).
Les images clés destinées au réglage du volume s’affichent sous forme de losanges blancs.
Marquage d’image clé indiquant 
un changement du volume.
Pour les effets comportant plusieurs paramètres, les images clés du paramètre sélectionné 
s’affichent sous forme de losanges blancs, alors que celles des autres paramètres apparaissent en gris.
Les images clés s’affichent sous forme de losanges blancs pour tous les paramètres lorsque 
vous sélectionnez Tous dans le menu local Effet. Une paire de losanges indique que vous avez 
ajouté des images clés à plusieurs paramètres au point indiqué.
• Dans l’inspecteur audio : placez la tête de lecture dans la timeline à l’endroit où vous souhaitez 
ajouter une image clé, puis cliquez sur le bouton Image clé (ou appuyez sur Option + K).
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Une fois l’image clé ajoutée, le bouton Image clé devient jaune, indiquant que la tête de lecture est positionnée sur une image clé.
Lorsque vous déplacez la tête de lecture dans la timeline, des flèches s’affichent à côté du 
bouton Image clé dans l’inspecteur audio pour indiquer de quel côté de la tête de lecture des 
images clés sont placées. Pour revenir à l’image clé précédente, cliquez sur la flèche gauche ou 
appuyez sur Option + Point-virgule (;). Pour passer à l’image clé suivante, cliquez sur la flèche 
droite ou appuyez sur Option + apostrophe (’).
Cliquez sur la flèche 
correspondante pour 
accéder à l’image clé 
précédente ou suivante.
5 Ajoutez des images clés si nécessaire.
Conseil : après avoir ajouté une image clé, il vous est possible d’en ajouter une autre automatiquement en déplaçant la tête de lecture sur la timeline, puis en ajustant la valeur de paramètre 
de l’effet (ou le curseur du volume lors de l’animation du volume à l’aide d’images clés) dans 
l’inspecteur audio.
Ajout automatique d’images clés sur une zone sélectionnée
Pour ajuster le volume d’un plan de la timeline, vous pouvez utiliser l’outil Sélection de plage 
pour ajouter automatiquement des images clés sur une zone sélectionnée.
Si un effet est assorti d’un triangle d’affichage dans l’éditeur d’animation audio, vous pouvez 
utiliser l’outil Sélectionner ou Sélection de plage pour ajouter des images clés sur une 
zone sélectionnée.
1 Procédez de l’une des manières suivantes:
• Sélectionnez le plan dans la timeline, puis choisissez Plan > Afficher l’animation audio (ou 
appuyez sur Contrôle + A).
• En maintenant la touche Contrôle enfoncée, cliquez sur le plan dans la timeline, puis choisissez 
« Afficher l’animation audio » dans le menu contextuel. 
Si vous ajoutez des images clés uniquement pour réaliser des réglages de volume, passez à 
l’étape 3.
2 Sélectionnez un effet, puis cliquez sur le triangle d’affichage pour le développer dans l’éditeur 
d’animation audio.
Triangle 
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3 Dans la timeline, effectuez l’une des opérations suivantes:
• Si vous n’ajustez que le volume : Choisissez Sélection de plage dans le menu local Outils de la 
barre d’outils (ou appuyez sur la touche R).
Le pointeur prend la forme de l’outil Sélection de plage . 
• Si vous ajustez un effet dans l’éditeur d’animation audio : choisissez Sélectionner ou Sélection 
de plage dans le menu local Outils de la barre d’outils (ou appuyez sur la touche A pour 
Sélectionner ou sur la touche R pour Sélection de plage).
4 Faites glisser le pointeur sur la zone où vous voulez ajuster le volume ou l’effet.Chapitre 9 Montage audio 204
5 Ajustez le volume ou l’effet sur la plage en déplaçant verticalement la commande horizontale.
Les images clés sont automatiquement créées le long des points d’ajustement dans la plage.
Ajustement des images clés dans l’éditeur d’animation audio
Vous pouvez déplacer horizontalement des images clés dans l’éditeur d’animation audio. Si un 
effet présente un triangle d’affichage, vous pouvez développer la présentation de l’effet et déplacer verticalement les images clés pour modifier la valeur du paramètre.
1 Sélectionnez une image clé.
2 Procédez de l’une des manières suivantes:
• Pour repositionner l’image clé dans l’éditeur d’animation audio, faites-la glisser vers la gauche 
ou la droite.
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• Si un effet présente un triangle d’affichage, cliquez sur ce dernier (ou double-cliquez sur l’effet) 
pour développer la présentation de l’effet.
Triangle 
d’affichage
Une fois l’effet développé, vous pouvez faire glisser l’image clé verticalement pour modifier la 
valeur du paramètre de l’effet.
Conseil : pour régler les valeurs avec plus de précision, maintenez la touche Commande 
enfoncée tout en faisant glisser verticalement l’image clé.
Pour ajouter une autre image clé, maintenez la touche Option enfoncée et cliquez (ou 
appuyez sur Option + K) sur la commande de l’effet à l’endroit où vous voulez ajouter 
l’image clé. Pour ajouter une image clé et modifier la valeur de paramètre de l’effet en une 
seule opération, maintenez la touche Option enfoncée, puis faites glisser la commande de 
l’effet verticalement.
Ajustement des images clés dans l’inspecteur audio
Pour de nombreux effets, vous pouvez ajuster la valeur du paramètre des différentes images clés 
à l’aide de l’inspecteur audio.
1 Sélectionnez ou placez la tête de lecture sur une image clé, puis ajustez la valeur du paramètre 
dans l’inspecteur audio.
2 Pour modifier la valeur de l’image clé suivante, accédez à celle-ci et ajustez à nouveau sa valeur.
Ajustement simultané de toutes les images clés dans l’éditeur d’animation audio
m Maintenez les touches Commande et Option enfoncées et faites glisser soit une image clé, soit la 
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Toutes les images clés sont alors ajustées de la même amplitude, préservant ainsi la forme créée 
par les ajustements apportés par images clés.
Avant
Après 
Affichage d’un seul effet à la fois dans l’éditeur d’animation audio
Vous pouvez condenser l’éditeur d’animation audio pour afficher un seul effet à la fois. Cela peut 
être utile si vous appliquez plusieurs effets à un plan et que vous souhaitez conserver de l’espace 
à l’écran.
1 Choisissez Plan > Solo de l’animation (ou appuyez Maj + Contrôle +V).
2 Dans l’éditeur d’animation audio, cliquez sur le triangle en regard du nom de l’effet pour choisir 
un effet dans le menu local.
Remarque : Lorsque l’option « Solo de l’animation » est activée, vous ne pouvez pas supprimer 
d’effet depuis l’éditeur d’animation audio.
Pour désactiver « Solo de l’animation », choisissez Plan > Solo de l’animation (ou appuyez sur 
Maj + Contrôle +V).
Suppression d’images clés
Procédez de l’une des manières suivantes:
m Sélectionnez une image clé dans l’éditeur d’animation audio et appuyez sur la touche Supprimer.
m Accédez à une image clé dans l’inspecteur audio, puis cliquez sur le bouton Image clé.
Bouton 
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Masquage de l’animation audio
Procédez de l’une des manières suivantes:
m Sélectionnez le plan dans la timeline, puis choisissez Plan > Masquer l’animation audio (ou 
appuyez sur Contrôle + A).
m Cliquez sur le bouton de fermeture situé dans l’angle supérieur gauche de l’éditeur 
d’animation audio.
m En maintenant la touche Contrôle enfoncée, cliquez sur le plan dans la timeline, puis choisissez 
« Masquer l’animation audio » dans le menu contextuel. 
Outils et techniques audio
Amélioration de l’audio
Final Cut Pro comprend plusieurs outils puissants d’analyse et d’amélioration des parties audio 
des plans, entre autres ceux présentés ci-dessous.
• Tonalité : améliore le signal audio principal et le rend plus uniforme.
• Suppression du bruit de fond réduit le bruit d’arrière-plan.
• Suppression du bourdonnement: réduit le bourdonnement habituel d’origine électrique à 50 
ou 60 Hz.
Vous pouvez analyser l’audio et ajuster la tonalité, le bruit de fond et les bourdonnements à 
l’aide de l’inspecteur d’améliorations audio. Vous pouvez aussi analyser et corriger des problèmes 
audio lors de l’importation d’un plan.
La section Améliorations audio de l’inspecteur audio inclut également les éléments suivants:
• Égalisation : améliore les hautes fréquences, les fréquences moyennes et les basses fréquences.
Toutes les améliorations sont conçues pour corriger les problèmes audio les plus courants, automatiquement ou par des ajustements mineurs. 
Remarque : Lorsque vous importez un plan, la fonction d’analyse et de correction audio résout 
uniquement les problèmes audio importants. Si le plan contient des problèmes moyennement 
importants, ceux-ci s’affichent en jaune à côté de l’analyse audio de la section Amélioration audio 
de l’inspecteur audio une fois le plan importé. Pour corriger ces problèmes, vous devez améliorer 
automatiquement l’audio dans l’inspecteur d’améliorations audio.
Analyse de l’audio
1 Sélectionnez un clip audio ou un plan vidéo qui contient de l’audio dans la timeline.
2 Pour analyser l’audio, effectuez l’une des opérations suivantes:
• Choisissez Fenêtre > Aller à > Afficher les améliorations audio (ou appuyez sur 
Commande + 8).
• Choisissez « Afficher les améliorations audio » dans le menu local Améliorations de la barre 
d’outils.
• Dans l’inspecteur audio, cliquez sur le bouton de l’inspecteur d’améliorations audio à côté 
d’Analyse audio de la section Améliorations audio. (Le bouton change de couleur si des ajustements ont été effectués.)Chapitre 9 Montage audio 208
L’inspecteur des améliorations audio s’affiche. Après l’analyse, des indicateurs apparaissent à côté 
de chaque amélioration pour afficher les résultats:
• un signe rouge indique un problème sévère ;
• un triangle d’avertissement jaune indique un problème potentiel ;
• une coche verte indique qu’il n’y a pas de problème.
3 Pour fermer l’inspecteur d’améliorations audio, cliquez sur le bouton Précédent .
Vous pouvez modifier automatiquement ou manuellement les réglages des améliorations pour 
corriger des problèmes. 
Amélioration automatique de l’audio
Vous avez la possibilité d’améliorer automatiquement l’audio pour analyser et corriger des problèmes de tonalité, de bruit de fond ou de bourdonnement.
1 Sélectionnez un clip audio ou un plan vidéo contenant de l’audio dans la timeline.
2 Procédez de l’une des manières suivantes:
• Choisissez Modifier > Amélioration de l’audio automatique.
• Choisissez « Amélioration de l’audio automatique » dans le menu local Améliorations de la 
barre d’outils.
• Cliquez sur le bouton Amélioration automatique en bas de l’inspecteur d’améliorations audio.
3 Pour fermer l’inspecteur d’améliorations audio, cliquez sur le bouton Précédent . 
À l’issue de l’analyse, une coche verte s’affiche à côté d’une amélioration, indiquant que le plan 
a été analysé en vue de l’amélioration en question. Des détails s’affichent si une correction est 
appliquée automatiquement.
Une coche bleue s’affiche à côté de chaque amélioration activée pour appliquer une correction. 
Décochez la case pour désactiver une amélioration.
Application manuelle d’améliorations
Une fois l’analyse de l’audio terminée, vous pouvez ajuster les améliorations manuellement.
1 Sélectionnez un clip audio ou un plan vidéo contenant de l’audio dans la timeline.
2 Pour afficher l’inspecteur d’améliorations audio, procédez de l’une des façons suivantes:
• Choisissez Fenêtre > Aller à > Afficher les améliorations audio (ou appuyez sur 
Commande + 8).
• Choisissez « Afficher les améliorations audio » dans le menu local Améliorations de la barre 
d’outils.
• Dans l’inspecteur audio, cliquez sur le bouton de l’inspecteur d’améliorations audio à côté 
d’Analyse audio de la section Améliorations audio. (Lorsque vous réalisez des ajustements, le 
bouton change de couleur.)Chapitre 9 Montage audio 209
3 Pour activer une amélioration, cliquez sur son icône ou cochez sa case (celle-ci est bleue lorsque 
l’amélioration est activée).
Case bleue
4 Si nécessaire, procédez de l’une des façons suivantes:
• Pour modifier les réglages Tonalité : déplacez les curseurs Quantité et Uniformité exprimés 
en pourcentages. Le curseur Quantité augmente ou diminue la tonalité globale (compression) du plan ou du clip, tandis que le curseur Uniformité augmente ou diminue la plage 
dynamique concernée.
• Pour changer le pourcentage de suppression du bruit de fond : faites glisser le curseur Quantité.
• Pour supprimer le bourdonnement: choisissez la valeur 50 Hz ou 60 Hz pour Suppression 
du bourdonnement.
5 Pour fermer l’inspecteur d’améliorations audio, cliquez sur le bouton Précédent . 
Ajustement de l’égalisation
1 Sélectionnez le plan dans la timeline.
2 Dans la section Améliorations audio de l’inspecteur audio, choisissez un préréglage d’égalisation dans le menu local Égalisation ou cliquez sur le bouton Commandes pour réaliser des 
ajustements manuels.
Bouton 
d’accès aux 
commandes
Choisissez un préréglage 
dans ce menu local.
Si vous voulez qu’un plan sonne comme un autre plan, vous pouvez faire correspondre l’audio.
Synchronisation automatique de l’audio et de la vidéo
Final Cut Pro est en mesure d’analyser et de synchroniser automatiquement les clips audio et les 
plans vidéo de votre projet.
Par exemple, si vous sélectionnez deux plans vidéo et trois clips audio de différentes sources 
enregistrées lors d’une même prise, Final Cut Pro analyse et synchronise ensemble automatiquement les plans sous forme de nouveau plan dans le navigateur d’événements.Chapitre 9 Montage audio 210
Final Cut Pro analyse les plans pour rechercher les points synchrones, tels que des marqueurs 
que vous avez ajoutés, le timecode, la date de création des fichiers et le contenu audio. Si aucun 
point synchrone n’est trouvé, les plans sont synchronisés à leur point de départ respectif.
Plans sélectionnés dans le navigateur d’événements
Nouveau plan contenant des plans synchronisés
Contenu du 
plan synchronisé
Scénario principal pour le 
plan synchronisé
Plans connectés
Synchronisation des plans
1 Sélectionnez les clips audio et les plans vidéo à synchroniser dans le navigateur d’événements.
2 Choisissez Plan > Synchroniser les plans (ou appuyez sur les touches Commande +Option + G).
Les plans synchronisés portent alors l’intitulé de « Plan synchronisé » dans le navigateur d’événements. Ces modifications ne se répercutent pas sur les plans originaux.
Si votre plan synchronisé comprend des canaux audio qui ne sont plus utilisés, vous pouvez les 
désactiver. Consultez Configuration des canaux audio à la page 176.Chapitre 9 Montage audio 211
Correspondance des réglages d’égalisation audio
La fonctionnalité « Faire correspondre l’audio » utilise l’égalisation pour faire correspondre le son 
d’un plan sélectionné à celui d’un autre plan. Cela s’avère particulièrement utile lorsque vous 
possédez divers clips audio enregistrés dans des environnements différents et que vous souhaitez qu’ils adoptent un son similaire. 
Correspondance audio
1 Sélectionnez le ou les plans que vous souhaitez modifier dans la timeline.
2 Procédez de l’une des manières suivantes:
• Choisissez Modifier > Faire correspondre l’audio.
• Choisissez Correspondance dans le menu local Égalisation de la section Améliorations audio 
de l’inspecteur audio.
• Choisissez « Faire correspondre l’audio » dans le menu local Améliorations de la barre d’outils.
3 Cliquez pour sélectionner le plan ou clip auquel vous souhaitez faire correspondre le son.
4 Cliquez sur Appliquer la correspondance.
Une fois la correspondance appliquée, vous pouvez modifier les réglages dans la section 
Améliorations audio de l’inspecteur audio.
Suppression de la correspondance audio
1 Sélectionnez le plan dans la timeline.
2 Dans la section Améliorations audio de l’inspecteur audio, choisissez un autre réglage d’égalisation dans le menu local Égalisation.
Pour supprimer toute égalisation, choisissez le réglage Plat.
Conservation de la tonalité lors de la resynchronisation des plans
Par défaut, Final Cut Pro préserve la tonalité lors de la resynchronisation des plans afin que le 
son ne soit pas plus aigu en lecture rapide ou plus grave en lecture lente. Vous pouvez activer ou 
désactiver cette fonctionnalité avant ou après la resynchronisation d’un plan.
Activation ou désactivation de la fonction Conserver la tonalité
1 Dans la timeline, sélectionnez un plan complet, ou une plage d’un plan, dont vous souhaitez 
modifier la vitesse.
2 Choisissez Conserver la tonalité dans le menu local Resynchronisation de la barre d’outils.
Une coche à gauche du nom de la commande indique que la fonctionnalité Conserver la tonalité 
est activée. Pour la désactiver, sélectionnez à nouveau Conserver la tonalité.10
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Présentation des transitions, des titres, des effets et des générateurs
Il vous est possible d’ajouter facilement des effets spéciaux à de la vidéo, à de l’audio et à des 
photos inclus dans vos projets. Final Cut Pro propose plusieurs types d’effets et de commandes: 
• Transitions: ajoutez un effet entre des plans afin de diriger les changements d’un plan à un 
autre. Consultez Présentation des transitions à la page 213.
• Titres: ajoutez du texte à n’importe quel point de votre projet. Consultez Présentation des 
titres à la page 222.
• Effets: exploitez un large éventail d’effets applicables à vos plans vidéo et à vos clips audio, 
d’effets les plus subtils (du grain ajouté à une vidéo ou un effet de couleur, ou un égaliseur 
graphique appliqué à l’audio) aux plus marqués (effet du clapotis de gouttelettes ou vision 
d’un insecte appliqué à la vidéo, ou encore une tonalité plus élevée de l’audio). Il existe deux 
types principaux d’effets:
• Effets intégrés: ces effets standard vous permettent de redimensionner, déplacer, faire pivoter, 
effectuer un trim, incliner, rogner ou appliquer l’effet de zoom Ken Burns à un plan vidéo. Ces 
effets sont déjà intégrés à chaque plan affiché sur la timeline ; vous n’avez dès lors qu’à les 
ajuster. Consultez Présentation des effets intégrés à la page 228.
• Effets de plan : ceux-ci sont conçus pour modifier des plans vidéo et des clips audio dans le 
but de corriger des problèmes, de créer des atmosphères nouvelles ou de générer des sons 
inédits. Consultez Présentation des effets de plans à la page 240.
• Générateurs: ajoutez un élément particulier comme un plan repère d’emplacement, un 
générateur de timecode ou un compte à rebours, ou ajoutez des couleurs, des motifs ou des 
arrière-plans animés à votre projet. Consultez Présentation des générateurs à la page 246.
• Commandes à l’écran : personnalisez de nombreux effets à l’aide des commandes à l’écran. 
Consultez Présentation des commandes à l’écran à la page 251.
• Animation vidéo : faites varier les réglages des effets au fur et à mesure de la lecture d’un plan. 
Consultez Présentation de l’animation vidéo à la page 256.
Vous pouvez ajouter des effets à n’importe quel plan repris sur la timeline. Une fois ajoutés (ou 
ajustés dans le cas d’effets intégrés), vous pouvez personnaliser les effets par le biais des commandes prévues dans un inspecteur, des commandes à l’écran du visualiseur et celles dont les 
éditeur d’animation vidéo et éditeur d’animation audio sont dotés. Il vous est également possible de tester plusieurs versions d’un effet par le biais d’auditions.
Vous pouvez ouvrir la plupart des effets et générateurs depuis Motion, une application Apple 
conçue pour fonctionner avec Final Cut Pro, afin d’en personnaliser et d’en enregistrer des 
versions spécialisées.
Ajout de transitions, de titres, 
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Ajout et réglage de transitions
Présentation des transitions
Vous avez la possibilité d’ajouter des fondus enchaînés et autres effets de transition entre des 
coupes pour donner de l’attrait à votre programme.
Les transitions remplacent un plan par un autre sur une durée donnée ; lorsqu’un plan se termine, un autre le remplace. L’on rencontre trois types de transitions vidéo particulièrement courants dans les projets vidéo : les fondus, les fondus enchaînés et les balayages.
Vous pouvez ajouter des transitions audio uniquement à des montages audio au sein d’un scé-
nario. Il peut s’agir d’un fondu entrant, sortant ou enchaîné.
Remarque : Si vous ajoutez une transition à un plan vidéo contenant de l’audio, une transition en 
fondu enchaîné est automatiquement appliquée à l’audio. Si l’audio est dissocié ou développé 
par rapport à la vidéo, la piste audio n’est alors pas affectée par la transition vidéo.
Création des transitions
Les transitions nécessitent le chevauchement de vidéo entre les plans, de chaque côté du point 
de montage. Une transition d’une seconde impose une seconde de vidéo tirée de la fin du plan 
de gauche et une seconde de vidéo reprise du début du plan de droite. En appliquant une 
transition à un point de montage, Final Cut Pro tente d’utiliser la vidéo supplémentaire tirée de 
chacun des plans pour créer la superposition. Ces sections supplémentaires (inutilisées) de plans 
sont connues sous le nom de poignées de média. L’image suivante représente un plan doté de 
gestionnaires de média de chaque extrémité et un plan sans autre vidéo supplémentaire, ou gestionnaire de média, à son début.
Plan sélectionné dans le navigateur d’événements
Aucune poignée de début du média
Poignée de début du média Poignée de fin du média
Poignée de fin du média
Il se peut que la vidéo de gestionnaire de média ne soit pas adaptée à son exploitation dans une 
transition. Par exemple, si la vidéo comprend des parties inutilisables, telles qu’un clap, celles-ci 
sont alors visibles dans le projet.
Vous pouvez définir la durée par défaut des transitions. Consultez Définition des valeurs par 
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L’illustration ci-dessous indique comment créer des transitions lorsque les plans, d’un côté ou 
d’un autre du point de montage, possèdent des poignées de média. La transition est placée de 
sorte qu’elle s’étend sur les plans; une moitié de la transition vient coïncider sur chacun des 
deux plans adjacents. Le média inutilisé issu de la fin de chaque plan est ainsi ajouté afin de remplir la transition. La durée globale du projet s’en voit inchangée.
Montage sans transition
Poignée de média
Plan 1 Plan 2
Plan 1
Plan 2
Poignée de média
Montage avec transition (poignées de média utilisées)
Si un ou les deux plans ne disposent pas de contenu supplémentaire suffisant (poignées de 
média) pour prendre en charge une transition de la durée par défaut, l’option de superposer du 
média de votre projet vous est proposée pour créer la transition.
Final Cut Pro exploite toutes les poignées de média disponibles puis fait coïncider le média 
nécessaire pour créer la transition. L’illustration ci-dessous reprend la création d’une transition 
sans poignée de média. Les deux plans sont destinés à se chevaucher et la transition se voit 
placée sur la région de superposition. Il s’agit dès lors d’un montage de superposition (ripple 
trim) et la durée totale de votre projet s’en trouve réduite.
Montage sans transition
Plan 1 Plan 2
Plan 1
Plan 2
Montage avec transition (aucune poignée de média utilisée)
Définition des valeurs par défaut de transition
Vous pouvez définir la transition par défaut utilisée grâce au raccourci clavier Commande +T. Il 
vous est également possible de définir la durée par défaut des transitions.
Définition de la transition par défaut
1 Dans la barre d’outils, cliquez sur le bouton Transitions.
2 Cliquez sur une transition tout en maintenant la touche Contrôle enfoncée, puis choisissez Par 
défaut dans le menu contextuel.
Définition de la durée par défaut
Vous devez définir la durée par défaut des transitions dans les préférences de Final Cut Pro.
1 Choisissez Final Cut Pro > Préférences, ou appuyez sur Commande +Virgule (,), puis cliquez 
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2 Utilisez la case de valeur « La durée est de x secondes » pour régler la durée exprimée en 
secondes de toutes les transitions que vous ajoutez à la timeline.
Vous avez la possibilité d’adapter la durée d’une transition après que cette dernière ait été placée 
sur la timeline.
Remarque : Certaines transitions disposent d’une durée définie et ne sont pas affectées par 
ce réglage.
Ajout de transitions au projet
Plusieurs méthodes vous sont proposées pour ajouter des transitions à un projet. Une fois une 
transition ajoutée, vous avez la possibilité de régler ses paramètres. Vous pouvez également modifier l’effet de transition dans Motion.
Ajout d’un fondu croisé
1 Choisissez l’outil de sélection dans le menu local Outils accessible à partir de la barre d’outils (illustré ci-dessous), puis cliquez sur le bord d’un plan (appelé point de montage) dans la timeline.
L’un des bords ou les deux bords de plan sont mis en surbrillance.
Remarque : Si vous sélectionnez un plan entier sur la timeline plutôt qu’un simple point de montage, les transitions se voient alors ajoutées à chaque extrémité du plan sélectionné.
2 Choisissez Édition > Ajouter un fondu enchaîné (ou appuyez sur Commande +T).
Le fondu croisé est inséré en s’appuyant sur le réglage « Appliquer les transitions utilisant ». Pour 
en savoir plus, consultez Définition des valeurs par défaut de transition à la page 214. Si le plan 
vidéo contient une piste audio, une transition en fondu enchaîné s’applique à l’audio.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 216
Ajout ou modification d’une transition à l’aide du navigateur de transitions
1 Dans la barre d’outils, cliquez sur le bouton Transitions.
2 Sélectionnez une transition.
Placez le pointeur sur les vignettes des transitions pour obtenir un aperçu de chacune d’entre 
elles. De plus, il vous est possible de taper du texte dans le champ de recherche pour filtrer la 
liste des transitions qui apparaissent à l’écran.
3 Procédez de l’une des manières suivantes:
• Pour appliquer la transition à un point de montage : faites-y glisser la transition.
• Pour remplacer une transition déjà placée dans le projet: faites-y glisser la transition.
Conseil : Une autre solution consiste à sélectionner tout d’abord le point de montage, puis de 
double-cliquer sur une transition dans le navigateur de transitions pour l’appliquer.
La transition est alors ajoutée au montage en s’appuyant sur le réglage « Appliquer les transitions utilisant ». Pour en savoir plus, consultez Définition des valeurs par défaut de transition à la 
page 214. Si le plan vidéo contient une piste audio, une transition en fondu enchaîné s’applique 
à l’audio.
Ajout d’un fondu enchaîné audio automatique
Si un plan vidéo contient de l’audio, la piste audio se voit automatiquement appliquée une transition de fondu enchaîné au moment où une transition vidéo est appliquée. Si l’audio est dissocié ou développé par rapport à la vidéo, la piste audio n’est alors pas affectée par la transition 
vidéo. Suivez ces étapes pour ajouter un fondu enchaîné audio entre des clips audio dissociés 
d’un scénario connecté.
1 Créez un scénario uniquement audio connecté au scénario principal.
Pour en savoir plus sur la création de scénarii, consultez Ajout de scénarios à la page 274.
2 Faites appel à l’outil de sélection, cliquez sur le bord d’un plan (à savoir un point de montage) 
dans le scénario.
L’un des bords ou les deux bords de plan sont mis en surbrillance.
Remarque : Si vous sélectionnez dans le scénario un plan entier plutôt qu’un simple point de 
montage, les transitions se voient alors ajoutées à chaque extrémité du plan sélectionné.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 217
3 Pour insérer un fondu enchaîné, choisissez Édition > Ajouter un fondu enchaîné (ou appuyez sur 
Commande +T).
Le fondu enchaîné est inséré en s’appuyant sur le réglage « Appliquer les transitions utilisant ». 
Pour en savoir plus, consultez Définition des valeurs par défaut de transition à la page 214. 
Vous pouvez configurer les réglages de fondu entrant et de fondu sortant dans l’inspecteur 
de transition.
Copie d’une transition vers d’autres points de montage par le biais du menu Édition
1 Sélectionnez une transition sur la timeline, puis choisissez Édition > Copier (ou appuyez sur 
Commande + C).
2 À l’aide de l’outil Sélectionner, cliquez sur le bord d’un plan (un point de montage) dans la timeline, puis choisissez Édition > Coller (ou appuyez sur Commande +V).
Remarque : Si vous copiez une transition et que vous la collez sur un point de montage comportant déjà une transition, la transition existante est supprimée.
Copie d’une transition vers d’autres points de montage par glisser-déposer
m Sélectionnez une transition dans la timeline, appuyez sur la touche Option, puis faites glisser la 
transition sur un autre point de montage.
Remarque : Si vous copiez une transition et que vous la collez sur un point de montage comportant déjà une transition, la transition existante est supprimée.
Suppression de transitions du projet
Vous avez la possibilité de supprimer une transition en toute simplicité, rétablissant ainsi le point 
de montage en une simple coupe.
Suppression d’une transition
1 Sélectionnez les transitions de votre choix sur la timeline.
2 Appuyez sur la touche Supprimer.
Les transitions sélectionnées sont alors supprimées et leurs points de montage sont convertis en 
de simples coupes.
Important : Si une transition supprimée faisait appel à une superposition complète, le point de 
montage coïncide alors avec le point central où se trouvait la transition avant d’être supprimée, 
et non l’emplacement d’origine avant l’application de la transition. Vous pouvez passer par 
Édition > Annuler pour supprimer la transition et rétablir les plans à leur durée d’origine. Pour en 
savoir plus, consultez Création des transitions à la page 213.
Ajustement des transitions sur la timeline
Il vous est possible de régler la durée d’une transition et de la déplacer sur la timeline. Vous avez 
également la possibilité d’effectuer un trim de l’un des deux plans situés sous la transition.
Modification de la durée d’une transition
1 Sélectionnez une transition dans la timeline.
2 Procédez de l’une des manières suivantes:
• Choisissez Modifier > Modifier la durée (ou appuyez sur Contrôle +D), saisissez la durée 
voulue (celle-ci s’affiche dans le panneau de contrôle accessible depuis la barre d’outils) et 
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• Faites glisser l’une des extrémités de la transition en l’éloignant du centre de celle-ci pour la 
rallonger ou vers l’intérieur pour la raccourcir.
Faites glisser l’un des bords 
de la transition pour adapter 
sa durée.
La transition conserve son point central et effectue un trim équivalent de chaque côté et mentionne un nombre indiquant combien d’images sont ainsi ajoutées ou soustraites de la durée de 
la transition.
Déplacement de la transition
Le déplacement d’une transition réalise en fait un montage roll sous la transition, ajoutant ainsi 
du contenu à un plan sous-jacent tout en supprimant du contenu de l’autre plan. La durée globale du projet ne se voit pas affectée par cette modification. De plus, vous ne pouvez déplacer 
la transition que si des gestionnaires de média suffisants sont mis à disposition du plan en cours 
d’extension.
Plan 2
Poignée de média
Montage avec transition
Poignée de média
Plan 1
Plan 2
Poignée de média
 Poignée de média
Plan 1
Montage avec transition déplacée vers la droite
1 Sélectionnez une transition dans la timeline.
2 Faites glisser l’icône de trim de la transition sur la zone supérieure du centre de la transition.
Faites défiler le montage 
sous la transition.
Le montage sous la transition se convertit en montage roll : un plan est étendu et l’autre raccourci. Un nombre indique alors le nombre d’images à gauche (nombre négatif) ou à droite 
(nombre positif) affectées par le montage roll sous la transition.
Vous pouvez aussi utiliser l’éditeur de précision pour effectuer un montage roll de la transition.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 219
Trim d’un plan sous une transition
La transition comprend des icônes qui simplifient le trim à gauche ou à droite du plan sans affecter pour autant la transition.
1 Sélectionnez une transition dans la timeline.
2 Faites glisser l’une des icônes de trim situées dans la zone supérieure gauche ou supérieure 
droite de la transition.
Faites glisser pour effectuer 
un trim sur la droite du point 
de départ du plan.
Faites glisser pour 
effectuer un trim sur 
la gauche du point 
d’arrivée du plan.
Le déplacement de l’icône de trim en haut à gauche règle le point de départ du plan de droite ; 
faire glisser celle qui se trouve dans la partie supérieure droite adapte le point d’arrivée du plan 
de gauche. Un nombre indique alors le nombre d’images ajoutées (nombres négatifs) ou soustraites (nombres positifs) à la durée du plan. Le trim ne modifie pas la durée de la transition, mais 
il modifie celle du projet.
Vous pouvez aussi utiliser l’éditeur de précision pour effectuer un trim des plans situés sous 
la transition.
Ajustement des transitions dans l’inspecteur de transition et dans le 
visualiseur
Il vous est possible de régler une transition à l’aide des commandes de l’inspecteur de transition 
et du visualiseur.
Ajustement d’une transition par le biais de l’inspecteur de transition et du visualiseur
1 Si l’inspecteur de transition n’est pas déjà affiché à l’écran, choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4).
2 Dans la timeline, sélectionnez la transition à régler.
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Le visualiseur affiche tout réglage à l’écran que vous opérez en faisant glisser les poignées. 
L’inspecteur de transition affiche les autres paramètres que vous pouvez ajuster. En outre, certaines transitions disposent d’un cadre d’image vous permettant de sélectionner une image 
vidéo apparaissant dans le cadre de la transition.
Faites glisser les commandes à 
l’écran pour ajuster les réglages 
de transition sélectionnés.
Dans l’exemple ci-dessus, vous pouvez faire glisser le cercle blanc dans le visualiseur (appelé une 
commande à l’écran) pour positionner le centre du balayage circulaire, et le carré pour régler la 
largeur de la bordure (dans notre cas, son adoucissement). L’inspecteur de transition comprend 
un réglage pour les proportions et le traitement de la bordure du balayage circulaire (notamment la couleur de la bordure si vous choisissez un bord uni).
De plus, de nombreuses transitions possèdent des paramètres vous permettant de les animer 
avec des images clés. Par exemple, vous pouvez faire bouger le centre de la transition Cercle au 
fur et à mesure de la lecture du plan.
Pour en savoir plus sur l’ajustement de fondus enchaînés dans l’inspecteur de transition, consultez Application d’un fondu entrant ou sortant à l’audio à la page 181.
Ajustement des transitions avec plusieurs images
Plusieurs de celles-ci regroupent des zones remplies à l’aide d’images fixes issues des plans de 
chaque côté de la transition. Prenons l’exemple de la transition « Panoramique complet à droite » 
(l’une des transitions de la catégorie Tableau d’affichage).
Cette image porte le numéro 
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Les zones sont numérotées et mises en corrélation aux points numérotés autour de la transition 
sur la timeline.
Ajustement des transitions avec des points numérotés
1 Dans la timeline, sélectionnez la transition dotée de points numérotés.
2 Placez la tête de lecture sur la transition jusqu’à ce qu’apparaisse une zone portant le même 
nombre que celui des poignées numérotées reprises sur la timeline. 
3 Faites glisser la poignée numérotée pour sélectionner l’image destinée à remplir la zone.
4 Continuez jusqu’à obtenir les images choisies pour l’intégralité des zones.
Création de versions de transitions spécialisées dans Motion
De nombreuses transitions ont été élaborées dans Motion, une application Apple conçue pour 
fonctionner avec Final Cut Pro. Vous pouvez ouvrir ces transitions dans Motion, y apporter des 
modifications et enregistrer ces dernières sous forme de nouveau fichier de transition qui s’affiche ensuite dans le navigateur de transitions.
Important : Les étapes suivantes impliquent que Motion 5 soit installé sur votre ordinateur.
Modification d’une transition dans Motion
1 Dans la barre d’outils, cliquez sur le bouton Transitions.
2 Dans le navigateur de transitions, cliquez tout en maintenant la touche Contrôle enfoncée sur la 
transition à modifier, puis choisissez «Ouvrir une copie dans Motion » dans le menu contextuel.
Motion se lance automatiquement et ouvre le projet de la transition.
3 Modifiez le projet de transition.
Pour en savoir plus, consultez l’Aide Motion à l’adresse http://help.apple.com/motion.
4 Choisissez Fichier > Enregistrer sous (ou appuyez sur Commande + Maj + S), attribuez un nom à 
la nouvelle transition (appelée modèle dans Motion), affectez-la à une catégorie (créez-en une au 
besoin), choisissez un thème (le cas échéant), puis cliquez sur Publier.
Remarque : Si vous choisissez Fichier > Enregistrer, la transition s’enregistre alors en reprenant le 
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Ajout et réglage de titres
Présentation des titres
Les titres jouent un rôle clé car ils constituent un encadrement important (tels que les titres des 
génériques de début et de fin) et parce qu’ils transmettent les différentes dates et heures au sein 
du film. Les titres, spécialement ceux du tiers inférieur de l’écran, sont également utilisés dans 
les documentaires et les vidéos d’information, afin d’apporter des détails nécessaires quant aux 
sujets ou produits présentés à l’écran. Lors du montage, vous pouvez également ajouter des 
notes et des repères d’emplacement à votre projet. Les sous-titres peuvent s’avérer vitaux pour 
les films tournés dans une langue différente de celle du public.
Vous pouvez créer des titres et des génériques dans Final Cut Pro avec des effets. Les titres sont 
des plans synthétisés (semblables à des générateurs) produits par Final Cut Pro. Les plans de titre 
ne font référence à aucun média stocké sur disque dur. Lorsque vous ajoutez un titre sous forme 
de plan connecté directement au-dessus d’un autre plan, celui-ci apparaît comme arrière-plan du 
texte, vous évitant ainsi d’avoir à réaliser un autre compositing pour créer l’effet.
Ajout de titres au projet
Passez par le navigateur de titres pour ajouter des titres aux plans de votre projet. Après avoir 
ajouté du texte, vous pouvez en modifier le style pour élaborer le titre.
Ajout d’un titre à un plan du projet
1 Dans la timeline, positionnez la tête de lecture sur le point où vous comptez ajouter le titre.
2 Cliquez sur l’outil Titres dans la barre d’outils (ou appuyez sur Commande + 5).
3 Procédez de l’une des façons suivantes:
• Pour ajouter un titre à partir du navigateur de titres: double-cliquez sur le titre.
Un plan de titre est ajouté à l’emplacement de la tête de lecture.
• Pour ajouter un titre standard : choisissez Édition > Connecter un titre > Titre standard (ou 
appuyez sur Contrôle +T).
Un plan de titre « Titre standard » (sans effets ou animations) est ajouté à l’emplacement de la 
tête de lecture.
• Pour ajouter un tiers inférieur standard : choisissez Édition > Connecter un titre > Tiers inférieur 
standard (ou appuyez sur Maj + Contrôle +T).
Le plan de titre de bas d’écran « Tiers inférieur standard » (sans effets ou animations) est ajouté 
à l’emplacement de la tête de lecture.
Il se voit connecté au plan dans le scénario principal, au niveau de la tête de lecture. Sur le 
plan visuel, le titre est superposé au plan dans le scénario principal à l’emplacement de la tête 
de lecture. Si cette dernière ne se situe pas sur un plan, le titre est alors placé par défaut sur 
l’arrière-plan.
Ajout d’un titre en tant que plan dans le scénario principal
Il existe deux façons pour ajouter un titre dans le scénario principal sous forme de plan. Vous 
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m Pour ajouter un titre entre des plans sur la timeline : depuis le navigateur de titres, faites glisser un plan de titre sur le point de montage situé entre les plans à l’endroit où vous voulez 
qu’il apparaisse.
m Pour remplacer un plan existant sur la timeline par un plan de titre : faites glisser un titre du navigateur 
de titres sur le plan que vous voulez remplacer dans la timeline, puis choisissez Remplacer dans le 
menu contextuel.
Saisie de texte pour le titre
Après avoir ajouté un plan de titre au projet dans la timeline, il vous est possible d’attribuer du 
texte au titre dans le visualiseur.
1 Sélectionnez un plan de titre dans la timeline.
2 Placez la tête de lecture sur le plan de titre sélectionné.
3 Dans le visualiseur, double-cliquez sur le texte du titre, puis saisissez le texte de votre choix.
Double-cliquez sur le champ 
Bouton Couche de texte précédente pour taper le texte du titre.
Bouton Couche de texte suivante
4 Pour sélectionner un autre objet texte, procédez de l’une des manières suivantes:
• Cliquez sur le bouton « Couche de texte précédente » ou « Couche de texte suivante ».
• Double-cliquez sur un autre objet texte.
5 Tapez le texte voulu.
6 Pour quitter le mode d’édition de texte, appuyez sur Commande + Retour.
Remarque : Les boutons « Couche de texte précédente » et « Couche de texte suivante » prennent 
également en charge les marqueurs Édition de texte de Motion. Pour en savoir plus, consultez l’. 
Aide Motion à l'adresse http://help.apple.com/motion.
Réglage des titres
Vous avez la possibilité de modifier du texte dans le visualiseur et d’adapter l’apparence du texte 
d’un titre grâce à l’inspecteur de titre et à l’inspecteur vidéo. Par exemple, vous pouvez régler l’opacité d’un titre ou modifier la police, l’alignement, la couleur, l’éclat et l’ombre portée du texte.
Modification du texte du titre 
1 Double-cliquez sur un plan de titre dans la timeline.
2 Procédez de l’une des manières suivantes:
• Double-cliquez sur un objet texte dans le visualiseur.
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3 Modifiez le texte.
4 Pour quitter le mode d’édition de texte, appuyez sur Commande + Retour.
Adaptation de l’emplacement d’un titre à l’écran
1 Sélectionnez un plan de titre dans la timeline.
2 Placez la tête de lecture sur le plan de titre sélectionné.
3 Procédez de l’une des manières suivantes:
• Dans le visualiseur, faites glisser l’objet texte selon vos besoins.
• Double-cliquez sur l’objet texte et faites glisser le bouton de positionnement sur le 
nouvel emplacement.
Cliquez sur le bouton de positionnement 
(représenté par le petit cercle) et faites 
glisser le titre selon vos besoins.
Adaptation de l’opacité d’un titre
Si vous placez un titre sur un plan, il vous est alors possible d’ajuster la transparence du titre.
1 Double-cliquez sur un plan de titre dans la timeline.
2 Choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4), puis cliquez sur le 
bouton Vidéo situé en haut de la fenêtre qui apparaît.
Curseur 
Opacité
3 Dans la section Compositing, ajustez les réglages d’opacité.
4 Pour quitter le mode d’édition de texte, appuyez sur Commande + Retour.
Remarque : Il vous est également possible d’animer avec des images clés le réglage de l’opacité 
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Ajustement des réglages d’un titre
Vous pouvez modifier les réglages d’un titre dans l’inspecteur de titre.
1 Sélectionnez un plan de titre dans la timeline.
2 Choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4), puis cliquez sur le 
bouton Titre situé en haut de la fenêtre qui apparaît.
3 Ajustez le cas échéant les réglages proposés.
Remarque : Vous avez également la possibilité d’animer avec des images clés de nombreux 
réglages dans les inspecteurs de titre et de texte.
Modification du style du texte d’un titre
Vous pouvez modifier le style de texte d’un titre.
1 Double-cliquez sur un plan de titre dans la timeline.
Le titre apparaît dans le visualiseur et le texte dans le premier objet texte inclus dans le plan de 
titre est sélectionné.
2 Pour modifier un autre objet texte, sélectionnez-le dans le visualiseur.
3 Choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4).
4 Ajustez le cas échéant les réglages proposés.
5 Pour quitter le mode d’édition de texte, appuyez sur Commande + Retour.
Remarque : Vous avez également la possibilité d’animer avec des images clés de nombreux 
réglages dans les inspecteurs de titre et de texte.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 226
Réglage simultané de plusieurs objets texte dans un plan de titre
Vous pouvez adapter les réglages de plusieurs objets texte en une seule fois.
1 Sélectionnez un plan de titre dans la timeline.
2 Placez la tête de lecture sur le plan de titre sélectionné.
3 Dans le visualiseur, procédez de l’une des manières suivantes.
• Tout en maintenant la touche Commande enfoncée, sélectionnez les objets texte à modifier.
• Faites glisser le pointeur pour sélectionner les objets texte à modifier.
4 Choisissez Fenêtre > Afficher l’inspecteur (ou appuyez sur Commande + 4).
5 Ajustez le cas échéant les réglages proposés.
Utilisation de la règle pour agencer et aligner les objets de texte de paragraphe
Le texte créé dans Motion et certains titres du navigateur de titres contiennent du texte 
de paragraphe. Vous pouvez utiliser une règle et des onglets pour contrôler la présentation du texte de paragraphe. Pour en savoir plus, consultez l’Aide Motion à l’adresse 
http://help.apple.com/motion.
1 Double-cliquez sur un objet de texte de paragraphe dans le visualiseur.
2 Dans le visualiseur, cliquez sur le bouton Afficher la règle.
Remarque : Le bouton Afficher la règle s'affiche uniquement lorsque vous modifiez un objet de 
texte de paragraphe.
Une règle apparaît au-dessus de l’objet de texte de paragraphe dans le visualiseur. Les tabulations dans la règle indiquent comment le texte tabulé doit être aligné dans le texte sélectionné.
Centrer la 
tabulation
Tabulation 
décimale
Tabulation 
droite
Tabulation 
gauche
3 Procédez de l’une des façons suivantes:
• Pour ajouter une tabulation : cliquez sur la règle.
• Pour changer le type de tabulation ajoutée lorsque vous cliquez sur la règle : cliquez sur la règle 
tout en maintenant la touche Contrôle enfoncée, puis choisissez un type de tabulation dans le 
menu contextuel.
• Pour déplacer une tabulation : faites-la glisser sur la règle.
• Pour supprimer une tabulation : faites-la glisser en dehors de la règle.
• Pour changer de type de tabulation : cliquez sur la tabulation tout en maintenant la touche 
Contrôle enfoncée, puis choisissez un type de tabulation dans le menu contextuel.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 227
Suppression de titres du projet
Vous pouvez supprimer à tout moment un titre du projet.
Suppression d’un titre
m Sur la timeline, sélectionnez le titre à supprimer et appuyez sur Supprimer.
Recherche et remplacement de texte dans un projet
Si le projet contient plusieurs instances d’un mot ou d’une expression qui se retrouve dans 
plusieurs plans de titre, par exemple des noms, des entreprises ou des intitulés de poste, vous 
pouvez rechercher le mot ou l’expression et modifier rapidement chaque instance.
Recherche et remplacement de texte du titre
1 Choisissez Édition > Rechercher et remplacer le texte du titre.
2 Dans la fenêtre « Rechercher et remplacer le texte du titre » qui s’affiche, saisissez le texte à 
rechercher dans le champ Rechercher.
3 Dans le champ Remplacer, tapez le texte par lequel vous souhaitez remplacer celui recherché.
4 Pour indiquer où effectuer la recherche, procédez de l’une des manières suivantes:
• Pour rechercher du texte dans le plan de titre sélectionné : choisissez Titre sélectionné dans le 
menu local Rechercher dans.
Cette option s’avère utile pour la recherche dans des plans de titre incluant beaucoup de 
texte, tels que les génériques.
• Pour rechercher du texte parmi tous les plans de titre du projet: choisissez « Tous les titres du 
projet » dans le menu local Rechercher dans.
5 Procédez de l’une des façons suivantes:
• Pour rechercher respectant les majuscules telles qu’elles sont saisies dans le texte recherché : cochez 
la case Respecter la casse.
• Pour rechercher des mots entiers plutôt qu’un groupe de lettres dans des mots: cochez la case 
Mots entiers.
• Pour que la recherche reprenne depuis le début de l’élément recherché après avoir atteint la fin : 
cochez la case Rechercher en boucle.
6 Procédez de l’une des manières suivantes:
• Pour remplacer toutes les instances du texte en une seule fois: cliquez sur le bouton 
Tout remplacer.
• Pour remplacer uniquement l’instance sélectionnée du texte : cliquez sur le bouton Remplacer.
• Pour remplacer l’instance du texte sélectionnée et rechercher l’occurrence suivante du texte : cliquez 
sur le bouton Remplacer et rechercher.
• Pour passer à l’instance suivante ou précédente du texte recherché : cliquez sur le bouton respectif 
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Ajustement d’effets intégrés
Présentation des effets intégrés
Final Cut Pro comprend plusieurs effets vidéo intégrant chaque plan de la timeline, directement 
accessibles depuis le visualiseur ; tout ce qu’il vous reste à faire est de les sélectionner et d’y 
apporter vos ajustements. Ceux-ci vous permettent de :
• créer une image composite à partir de plusieurs plans;
• repositionner ou recadrer un plan en zoomant dessus;
• rogner un plan pour supprimer tous les éléments indésirables, tels que des micros ou l’équipement d’éclairage qui apparaissent accidentellement dans la vidéo ;
• configurer un effet Ken Burns pour apporter du souffle à vos images fixes (mais aussi à vos 
plans vidéo).
Il vous est possible d’exploiter plusieurs effets intégrés simultanément. Par exemple, vous pouvez 
faire appel à l’effet Transformer pour réduire la taille et la position de l’image, Trim pour supprimer une partie de la vidéo et Distorsion pour déformer la vidéo.
Vous pouvez animer ces effets pour qu’ils changent au fil de la lecture du plan. Par exemple, vous 
pouvez réduire la taille d’une image et la faire sortir de l’écran. Pour configurer une animation, 
vous devez modifier les réglages sur au moins deux points du plan. Au cours de la lecture du 
plan, Final Cut Pro crée des transitions animées et fluides entre ces points.
Redimensionnement, déplacement et rotation de plans
L’effet intégré Transformer vous permet de redimensionner, de faire pivoter et de déplacer une 
image. Cet effet est couramment utilisé sur un plan placé au-dessus d’un plan du scénario principal, qui devient alors l’arrière-plan du plan redimensionné. Il sert également souvent à zoomer 
sur un plan, vous permettant ainsi de recadrer une prise de vue au besoin.
Ajustement de l’effet Transformer
Les commandes disponibles dans le visualiseur et l’inspecteur vidéo vous permettent d’ajuster 
cet effet. Cependant, certaines commandes ne sont disponibles que dans l’un ou dans l’autre.
1 Sélectionnez un plan dans la timeline.
2 Pour accéder aux commandes Transformer, effectuez l’une des opérations suivantes:
• Choisissez Transformer à partir du menu local situé dans le coin inférieur gauche du visualiseur 
(ou appuyez sur Maj +T).
• Tout en maintenant la touche Contrôle enfoncée, cliquez dans le visualiseur sur le plan, puis 
choisissez Transformer dans le menu contextuel.
3 Pour régler l’effet à l’aide des commandes à l’écran :
• Poignées bleues situées à chaque coin : faites-les glisser pour ajuster la taille de l’image tout en 
conservant ses proportions.
• Poignées bleues situées au milieu de chaque côté : faites-les glisser pour adapter indépendamment la taille verticale ou horizontale de l’image, faisant ainsi varier les proportions de l’image.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 229
Remarque : Ces commandes ne sont pas accessibles depuis l’inspecteur vidéo.
• Cercle blanc situé au centre : indique le point d’ancrage pour la rotation. Faites glisser n’importe 
où le point actif à l’intérieur de l’image pour adapter sa position.
• Poignée bleue s’étendant depuis le cercle central : faites-la glisser pour faire pivoter l’image.
Conseil : Pour bénéficier d’une plus grande précision lors de la rotation de l’image, faites glisser la poignée de rotation en l’éloignant du point d’ancrage situé au centre.
Faites glisser la 
poignée d’un coin pour 
modifier la taille de 
l’image sans influer sur 
ses proportions.
Faites glisser la poignée 
d’un bord pour adapter les 
proportions de l’image.
Faites glisser l’image pour 
affiner sa position.
Faites glisser cette poignée 
pour faire pivoter l’image.
4 Utilisez les commandes Transformer dans l’inspecteur vidéo comme suit :
• Position X etY :utilisez ces commandes pour déplacer l’image horizontalement (axe des X) et 
verticalement (axe des Y).
• Rotation : faites-la glisser pour faire pivoter l’image autour de son point d’ancrage.
• Échelle : cette commande vous permet d’adapter la taille de l’image.
• Ancrage X etY :permet de déplacer le point central de l’image. Cette commande définit le 
point autour duquel l’image pivote.
Remarque : Elle ne se trouve pas parmi les commandes à l’écran.
5 Lorsque vous avez fini l’ajustement de l’effet et que vous n’avez plus besoin des commandes à 
l’écran, cliquez sur Terminé. 
Vous pouvez animer l’effet et le faire apparaître par dessus un arrière-plan. Pour en savoir plus sur 
la manipulation d’effets intégrés, consultez Manipulation d’effets intégrés à la page 235.
Trim de plans
Les commandes de trim vous permettent d’élaguer indépendamment chacun des bords 
de l’image, créant ainsi l’aspect d’une fenêtre. Cet effet, couramment employé avec l’effet 
Transformer, est généralement mis en œuvre sur un plan placé au-dessus d’un plan du scénario 
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Ajustement de l’effet Trim
1 Sélectionnez un plan dans la timeline.
2 Pour accéder aux commandes Trim, effectuez l’une des opérations suivantes:
• Choisissez Rogner à partir du menu local situé dans le coin inférieur gauche du visualiseur (ou 
appuyez sur Maj + C).
• Tout en maintenant la touche Contrôle enfoncée, cliquez dans le visualiseur sur le plan, puis 
choisissez Rogner dans le menu contextuel.
3 Cliquez sur le bouton Trim en bas du visualiseur.
4 Pour régler l’effet à l’aide des commandes à l’écran :
• Poignées bleues situées à chaque coin : faites-les glisser pour adapter en même temps la position de deux côtés de la fenêtre du trim.
• Poignées bleues situées au milieu de chaque côté : faites-les glisser pour ajuster indépendamment la position de chaque côté.
• N’importe où dans la fenêtre : faites glisser la fenêtre pour affiner sa position.
Faites glisser une poignée au milieu d’un bord 
pour ne modifier que le bord en question.
Faites glisser la poignée d’un angle pour 
modifier deux côtés simultanément.
Faites glisser l’image pour 
positionner la fenêtre du trim.
5 Pour adapter chaque bord indépendamment à l’aide de la zone de rognage de l’inspecteur 
vidéo, faites appel aux commandes Trim.
6 Lorsque vous avez fini l’ajustement de l’effet et que vous n’avez plus besoin des commandes à 
l’écran, cliquez sur Terminé. 
Vous pouvez animer l’effet et le faire apparaître par dessus un arrière-plan. Pour en savoir plus sur 
la manipulation d’effets intégrés, consultez Manipulation d’effets intégrés à la page 235.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 231
Rognage de plans
L’effet Rogner simplifie la suppression des zones indésirables de l’image. Il étend automatiquement l’image rognée de façon à lui faire remplir l’écran.
Ajustement de l’effet Rogner
1 Sélectionnez un plan dans la timeline.
2 Pour accéder aux commandes Rogner, effectuez l’une des opérations suivantes:
• Choisissez Rogner à partir du menu local situé dans le coin inférieur gauche du visualiseur (ou 
appuyez sur Maj + C).
• Tout en maintenant la touche Contrôle enfoncée, cliquez dans le visualiseur sur le plan, puis 
choisissez Rogner dans le menu contextuel.
3 Cliquez sur le bouton Rognage en bas du visualiseur.
4 Pour régler l’effet à l’aide des commandes à l’écran :
• Poignées bleues situées à chaque coin : faites-les glisser pour adapter le rognage du coin choisi. 
L’image rognée conserve toujours ses proportions d’origine.
• N’importe où dans la fenêtre : faites glisser la fenêtre de rognage pour affiner sa position.
Faites glisser la poignée d’un coin 
pour modifier la taille de la fenêtre 
de rognage (mais sans influer sur 
ses proportions).
Faites glisser l’image 
pour positionner la 
fenêtre du rognage.
Cliquez sur Terminé pour rogner l’image et 
l’afficher dans sa taille développée finale.
5 Pour adapter chaque bord indépendamment à l’aide de la zone de rognage de l’inspecteur 
vidéo, faites appel aux commandes Rogner.
Remarque : S’il vous est possible d’exploiter ces commandes pour modifier les proportions de la 
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6 Cliquez sur Terminé pour que le rognage s’applique enfin et pour retrouver l’image zoomée de 
façon à remplir l’écran.
Vous pouvez animer l’effet, créant ainsi l’illusion d’un panoramique et d’un zoom (il s’agit alors 
en fait d’un effet Ken Burns manuel). Pour en savoir plus sur la manipulation d’effets intégrés, 
consultez Manipulation d’effets intégrés à la page 235.
Panoramique et zoom des plans avec l'effet Ken Burns
L’effet Ken Burns crée un effet de panoramique et de zoom à l’aide de positions de départ et de 
fin que vous devez définir. L’effet Ken Burns représente en fait un effet Rogner marqué par deux 
réglages de rognage : l’un au début du plan et l’autre à sa fin.
Ajustement de l’effet Ken Burns
1 Sélectionnez un plan dans la timeline.
2 Pour accéder aux commandes Ken Burns, effectuez l’une des opérations suivantes:
• Choisissez Rogner à partir du menu local situé dans le coin inférieur gauche du visualiseur (ou 
appuyez sur Maj + C).
• Tout en maintenant la touche Contrôle enfoncée, cliquez dans le visualiseur sur le plan, puis 
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3 Cliquez sur le bouton Ken Burns en bas du visualiseur.
Deux rectangles apparaissent alors dans le visualiseur : un vert, qui définit l’emplacement et la 
taille pour le début du plan, et un rouge qui indique la position et la taille pour la fin du plan. 
Une flèche vient marquer la direction dans laquelle l’image avance lorsque le plan est reproduit.
Sélectionnez le rectangle vert Début 
ou le rectangle rouge Fin pour régler 
la taille et l’emplacement du rognage.
Cliquez sur le bouton 
Échange pour intervertir 
le départ et l’arrivée.
Cliquez sur le bouton Lecture 
en boucle pour reproduire le 
plan de façon continue.
Les réglages par défaut pour le début et la fin entraînent un zoom de faible amplitude vers le 
centre de l’image.
4 Pour choisir la partie de l’image qui apparaît au début de l’effet, faites glisser les poignées 
vertes pour modifier la taille de rognage de l’image et faites glisser la fenêtre pour définir 
son emplacement.
5 Pour choisir la partie de l’image qui apparaît à la fin de l’effet, faites glisser les poignées 
rouges pour modifier la taille de rognage de l’image et faites glisser la fenêtre pour définir 
son emplacement.
6 Pour reproduire continuellement le plan avec l’effet appliqué, cliquez sur le bouton Lecture 
en boucle.
7 Pour intervertir les emplacements du départ et d’arrivée, cliquez sur le bouton Échange.
8 Cliquez sur Terminé.
Conseil : Faites appel à l’effet Rogner et à des images clés intermédiaires pour créer un effet ressemblant à l’effet Ken Burns, qui suit cependant une trajectoire plus compliquée.
Pour en savoir plus sur la manipulation d’effets intégrés, consultez Manipulation d’effets inté-
grés à la page 235.
Inclinaison de la perspective d’un plan
L’effet Distorsion s’apparente à l’effet Transformer hormis que vous êtes en mesure de faire glisser 
chacun des coins indépendamment des autres, vous permettant ainsi de générer une apparence 
inclinée ou d’ajouter de la perspective à l’image.
Remarque : L’effet Distorsion modifie la forme de la vidéo sans pour autant la déplacer. Pour 
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Ajustement de l’effet Distorsion
1 Sélectionnez un plan dans la timeline.
2 Pour accéder aux commandes Distorsion, effectuez l’une des opérations suivantes:
• Choisissez Distorsion à partir du menu local situé dans le coin inférieur gauche du visualiseur 
(ou appuyez sur Commande + Maj +D).
• Tout en maintenant la touche Contrôle enfoncée, cliquez dans le visualiseur sur le plan, puis 
choisissez Distorsion dans le menu contextuel.
3 Pour régler l’effet à l’aide des commandes à l’écran :
• Poignées bleues situées à chaque coin : faites-les glisser pour repositionner chaque coin, ce qui 
ajoute de la perspective à l’image (une partie semble alors se projeter plus au premier plan 
que d’autres parties).
• Poignées bleues situées au milieu de chaque côté : faites-les glisser pour ajuster la position de 
chaque côté. Vous pouvez ainsi générer un effet d’inclinaison en les faisant glisser dans la 
même direction que leur bord (plutôt que par rapport au centre).
• N’importe où dans la fenêtre : faites glisser la fenêtre pour affiner sa position.
Faites glisser 
chaque coin pour 
définir sa position.
Faites glisser les poignées 
au milieu des arrêtes pour 
régler la position d’un côté.
4 Pour ajuster indépendamment chaque coin par le biais de l’inspecteur vidéo, servez-vous des 
commandes Distorsion.
5 Lorsque vous avez fini l’ajustement de l’effet et que vous n’avez plus besoin des commandes à 
l’écran, cliquez sur Terminé. 
Vous pouvez animer l’effet et le faire apparaître par dessus un arrière-plan. Pour en savoir plus sur 
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Manipulation d’effets intégrés
Les méthodes suivantes vous permettent de travailler avec des effets intégrés.
Désactivation ou réinitialisation de l’effet
1 Sélectionnez dans la timeline un plan incluant un effet.
2 Procédez de l’une des manières suivantes:
• Pour désactiver l’effet et conserver ses réglages: cliquez sur la case bleue en regard de l’effet utilisé (Transformer, Rogner ou Distorsion) dans l’inspecteur vidéo.
Vous pouvez cliquer à nouveau sur la case pour réactiver l’effet, simplifiant ainsi la comparaison du plan avec et sans l’effet.
Placez le pointeur sur cette zone et 
cliquez sur Afficher pour afficher les 
réglages d’un effet.
Cliquez sur une case pour activer 
ou désactiver un effet.
Cliquez sur l’icône d’un effet 
pour afficher ou masquer 
les commandes à l’écran 
correspondantes.
Cliquez sur le bouton 
Réinitialiser d’un effet pour 
rétablir les valeurs par 
défaut des réglages.
• Pour rétablir toutes les valeurs de l’effet à leur valeur par défaut: Cliquez sur le bouton 
Réinitialiser .
• Pour désactiver l’effet dans l’éditeur d’animation vidéo : ouvrez l’éditeur en choisissant Plan > 
Afficher l’animation vidéo (ou appuyez sur Contrôle +V), puis cliquez sur la case en regard de 
l’effet à désactiver.
Cliquez sur la case d’un effet 
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Animation d’effets intégrés
Utilisez des images clés pour faire évoluer les réglages de l’effet au fur et à mesure de la lecture 
du plan. Ceci s’applique à tous les effets intégrés sauf à l’effet Ken Burns.
1 Sélectionnez un plan dans la timeline.
2 Choisissez l’effet à animer à partir du menu local situé dans le coin inférieur gauche 
du visualiseur.
Dans le cadre de cet exemple, choisissez Transformer (ou appuyez sur Maj +T).
3 Positionnez la tête de lecture de la timeline au début du plan.
4 Réglez l’emplacement de départ à l’aide des commandes à l’écran de l’effet.
5 Cliquez sur le bouton « Ajouter une image clé » situé dans la partie supérieure du visualiseur.
Cliquez sur le bouton « Ajouter une 
image clé » pour ajouter à l’animation 
la première image clé.
6 Placez la tête de lecture sur la fin du plan.
7 Réglez l’emplacement de fin à l’aide des commandes de l’effet.
Une image clé est alors automatiquement ajoutée. De plus, dans le cas des effets Transformer, 
une ligne indique la trajectoire empruntée par l’image.
Cliquez sur la flèche gauche 
pour passer directement à la 
première image clé.
Une fois terminé, la 
création de l’animation, 
cliquez sur Terminé.
La ligne rouge indique la trajectoire 
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8 Pour confirmer vos opérations, cliquez sur Terminé dans le coin supérieur droit du visualiseur.
Une fois lancée la lecture du plan, la vidéo se déplace de façon fluide entre les images clés, 
créant ainsi une effet animé. Vous pouvez en fait ajouter plusieurs images clés en déplaçant la 
tête de lecture et en adaptant les commandes de l’effet. Pour en savoir plus sur l’utilisation des 
images clés, consultez Présentation de l’animation vidéo à la page 256.
Ajustement de la trajectoire d’animation de l’effet Transformer
Les animations par transformation présentent des commandes d’images clés complémentaires 
qui permettent d’affiner la trajectoire d’animation. Pour les afficher, vous devez au préalable créer 
un effet simple sur trois coins.
Le bouton « Ajouter une image clé » 
s’adapte en bouton « Supprimer l’image 
clé » lorsque le point actif se trouve sur 
une image clé.
Image clé 
du milieu
1 Sélectionnez un plan dans la timeline et placez la tête de lecture sur son début.
2 Sélectionnez Transformer à partir du menu local situé dans le coin inférieur gauche du visualiseur (ou appuyez sur Maj +T), puis faites glisser les commandes à l’écran pour réduire la taille de 
l’image et la placer dans le coin supérieur gauche.
3 Cliquez sur le bouton « Ajouter une image clé ».
4 Dans la timeline, placez la tête de lecture au milieu du plan.
5 Utilisez les commandes à l’écran Transformer pour déplacer l’image vers le coin supérieur droit.
Une image clé est automatiquement ajoutée et une ligne rouge indique le chemin emprunté 
jusqu’alors par l’animation.
6 Dans la timeline, placez la tête de lecture sur la fin du plan.
7 Servez-vous des commandes à l’écran Transformer pour déplacer l’image sur le centre inférieur.
Une image clé est automatiquement ajoutée et la ligne rouge s’étend alors jusqu’au 
nouveau point.
8 Pour passer directement d’une image clé à l’autre, cliquez sur les carrés blancs placés le long de 
la ligne rouge.
Les première et dernière images clés sont dotées de flèches blanches.
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9 Pour contrôler cette courbe représentant la trajectoire, cliquez sur l’image clé du début ou du 
milieu, puis faites glisser les poignées de courbe.
Faites glisser ces poignées 
sur une image clé du milieu 
pour ajuster la courbe de la 
trajectoire.
Image clé de départ
Image clé d’arrivée
10 Cliquez sur une image clé en maintenant la touche Contrôle enfoncée, puis choisissez une 
option dans le menu contextuel :
• Linéaire : sert aux trajectoires directes non courbes partant ou arrivant à l’image clé 
en question.
• Lissage : sert aux trajectoires courbes partant ou arrivant à l’image clé en question, offrant ainsi 
un mouvement plus naturel.
• Supprimer le point: permet de supprimer l’image clé.
• Verrouiller le point: permet d’empêcher tout ajustement de l’image clé. Une fois activé, son intitulé change en Déverrouiller le point.
• Désactiver le point: sert à ignorer l’image clé en question, mais la laisse en place pour pouvoir 
l’utiliser ultérieurement au besoin. Une fois activé, son intitulé change en Activer le point.
Effets composites sur un arrière-plan
Les effets Transformer, Trim et Distorsion génèrent souvent une image de taille inférieure à la 
taille réelle, avec des zones vides noires. Vous pouvez remplacer ces dernières par un arrièreplan en plaçant le plan transformé sur un plan d’arrière-plan, technique connue sous le nom 
de compositing.
Procédez de l’une des manières suivantes:
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Ceci entraîne le placement du plan au-dessus du plan du scénario principal, qui devient alors 
automatiquement l’arrière-plan de l’effet.
Plan composé sur le 
scénario principal
Plan situé dans le scénario principal, 
constituant l’arrière-plan
m Si le plan se trouve déjà dans le scénario principal, faites-le glisser au-dessus de celui-ci, en le 
positionnant sur le plan faisant office d’arrière-plan.
L’image devient ainsi une image composite.
Les effets Transformer et Trim ont 
permis de créer une image composite 
sur l’arrière-plan avec cette image.
Pour en savoir plus sur l’utilisation de plans connectés, consultez Ajout de scénarios à la 
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Ajout et réglage des effets de plans
Présentation des effets de plans
En plus des effets intégrés, Final Cut Pro contient une grande variété d’effets vidéo qu’il vous est 
possible d’appliquer aux plans vidéo de votre projet. De nombreux effets modifient l’apparence 
de votre vidéo, allant de l’ajout d’un flou ou d’un éclat à de fortes distorsions. Certains effets 
incrustent des graphismes issus d’un caméscope ou du timecode. Il existe aussi un effet pour 
l’incrustation d’un plan vidéo sur un autre.
Final Cut Pro inclut également un ensemble étendu d’effets audio applicables aux clips audio de 
votre projet. De nombreux effets modifient le son de votre audio, allant de l’ajout d’échos subtils 
à de fortes distorsions de la tonalité.
Après avoir ajouté un effet, vous avez la possibilité de régler ses paramètres. Certains effets ne 
disposent que de peu de réglages alors que d’autres en proposent un ensemble complet, vous 
permettant un contrôle étendu de leur apparence. Les effets peuvent en outre être animés, leurs 
réglages pouvant s’adapter lors de la lecture du plan.
Il est possible d’appliquer plusieurs effets à vos plans, en « empilant » des effets. Cependant, 
l’ordre dans lequel vous appliquez ces effets peut influer sur l’apparence finale de votre vidéo.
De plus, vous pouvez ouvrir de nombreux effets vidéo pour les modifier dans Motion, afin de 
créer des versions spécialisées utilisables dans vos projets.
Ajout d’effets au projet
Passez par le navigateur d’effets pour ajouter des effets aux plans de votre projet.
Ajout d’un effet à un plan du projet
1 Sélectionnez le plan voulu dans la timeline, puis cliquez sur le bouton Effets de la barre d’outils.
2 Dans le navigateur d’effets, sélectionnez un effet en vous aidant de l’un des éléments suivants:
• Pour effectuer un preview une fois l’effet appliqué à la vidéo tirée du plan sélectionné sur la timeline : placez le pointeur sur les vignettes d’effets vidéo.
• Pour effectuer un preview influant sur la commande principale de l’effet: maintenez la touche 
Option enfoncée tout en plaçant le pointeur sur la vignette d’un effet vidéo.
• Pour filtrer la liste des effets qui apparaissent à l’écran : saisissez le texte recherché dans le champ 
de recherche du navigateur d’effets.
3 Procédez de l’une des manières suivantes:
• Faites glisser l’effet sur le plan situé dans la timeline, auquel vous voulez l’appliquer.
• Double-cliquez sur la vignette de l’effet pour l’appliquer au plan sélectionné.
Il ne vous reste à présent qu’à adapter l’effet selon vos besoins.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 241
Réglage d’effets dans Final Cut Pro
Pour la plupart des effets, vous pouvez ajuster un ou plusieurs paramètres dans l’inspecteur 
vidéo ou audio, le visualiseur ou l’éditeur d’animation vidéo ou audio. Vous pouvez également 
contrôler l’application de l’effet au plan, soit progressivement, soit entièrement sur toute sa 
durée d’application.
Ajustement d’un effet dans l’inspecteur vidéo et dans le visualiseur
1 Sélectionnez dans la timeline un plan incluant un effet à adapter.
2 Accédez à l’effet dans l’inspecteur vidéo ou dans l’inspecteur audio.
Cliquez sur cette icône pour 
activer ou désactiver l’effet.
Cliquez dessus 
pour réinitialiser 
les ajustements 
de l’effet.
Dans l’exemple ci-dessus, plusieurs réglages sont sélectionnés pour l’effet Capteur. De nombreux 
effets disposent également d’ajustements qui apparaissent dans le visualiseur, connus sous le 
nom de commandes à l’écran.
Conseil : Dans le cas d’effets audio, il vous est possible de cliquer sur le bouton 
Commandes (qui se trouve à droite du nom de l’effet) pour afficher à l’écran une fenêtre de 
commande personnalisée.
Cliquez sur cette icône pour accéder à la fenêtre 
de commande personnalisée de l’effet.
3 Sélectionnez les paramètres d’effets et ajustez leurs réglages selon vos besoins.
Pour rétablir les valeurs par défaut des réglages des effets, vous avez la possibilité de cliquer sur 
le bouton Réinitialiser de l’effet.
Ajustement d’un effet dans l’éditeur d’animation vidéo
De nombreux paramètres d’effets peuvent être adaptés dans l’éditeur d’animation vidéo. De plus, 
il est possible de configurer ces paramètres de sorte qu’ils soient appliqués progressivement.
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2 Choisissez Plan > Afficher l’animation vidéo (ou appuyez sur Contrôle + V).
L’effet vient s’afficher dans l’éditeur d’animation vidéo au-dessus du plan, sous forme d’animation. Vous pouvez cliquer sur sa case pour activer ou désactiver l’effet. Les effets qui possèdent 
plusieurs attributs adaptables disposent également d’un menu local pour vous permettre de 
choisir l’attribut à afficher et à régler.
Double-cliquez sur 
les effets présentant 
cette icône pour 
les développer 
verticalement.
Choisissez un 
ajustement d’effet 
spécifique dans ce 
menu local.
Cliquez sur cette icône pour 
activer ou désactiver l’effet.
3 Pour étirer verticalement la zone d’ajustement de l’effet, choisissez un ajustement donné dans le 
menu local (si celui-ci est présent) et double-cliquez dessus.
Ceci ne s’applique qu’aux ajustements d’effet qui possèdent une seule valeur. Une icône apparaît 
à droite de la section de l’effet si l’ajustement peut être développé.
4 Pour que le réglage de l’effet effectue un fondu entrant et sortant du plan, faites glisser les poignées situées de chaque côté de l’effet.
Faites glisser les poignées de fondu pour 
appliquer progressivement l’effet.
Faites glisser cette 
ligne pour ajuster la 
valeur sélectionnée.
Il vous est également possible de faire glisser verticalement la ligne horizontale pour contrôler le 
réglage sélectionné de l’effet (Degré, dans le cas de l’exemple ci-dessus). Toutes les images clés 
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Affichage des effets audio appliqués à un plan
1 Sélectionnez dans la timeline un plan incluant un effet audio.
2 choisissez Plan > Afficher l’animation audio (ou appuyez sur Contrôle + A).
L’effet audio apparaît dans l’éditeur d’animation audio sous forme d’animation. Vous pouvez cliquer sur sa case verte pour activer ou désactiver l’effet.
Modification de l’ordre des effets
Vous pouvez appliquer plusieurs effets à un plan sur la timeline. L’ordre dans lequel vous les 
appliquez peut influer sur la sortie finale générée. Par exemple, l’application de l’effet Parasites, 
qui ajoute par défaut des cercles blancs aléatoires à la vidéo, avant l’effet Papier vieilli, génère par 
conséquent des cercles blancs dont l’aspect est également vieilli ; son application après l’effet 
Papier vieilli produit donc des cercles blancs inchangés.
Vous pouvez modifier en toute simplicité l’ordre des effets de plan dans l’inspecteur vidéo, dans 
l’inspecteur audio, dans l’éditeur d’animation vidéo ou dans l’éditeur d’animation audio.
Remarque : Vous ne pouvez pas adapter l’ordre des effets intégrés ou de l’étalonnage.
Modification de l’ordre des effets de plan vidéo et de clip audio à l’aide de l’inspecteur vidéo 
ou de l’inspecteur audio
1 Sélectionnez dans la timeline un plan vidéo ou un clip audio auquel plusieurs effets sont appliqués, puis procédez de l’une des manières suivantes:
• Pour constater le résultat des effets vidéo : ouvrez l’inspecteur vidéo.
• Pour constater le résultat des effets audio : ouvrez l’inspecteur audio.
2 Dans l’inspecteur vidéo ou l’inspecteur audio, faites glisser les effets pour en modifier l’ordre.
Les effets intégrés et 
l’étalonnage ne peuvent 
pas être réorganisés.
Faites glisser les 
effets de plan pour 
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Modification de l’ordre des effets de plan vidéo et de clip audio à l’aide de l’éditeur d’animation vidéo ou de l’éditeur d’animation audio
1 Sélectionnez dans la timeline un plan vidéo ou un clip audio auquel plusieurs effets sont appliqués, puis procédez de l’une des manières suivantes:
• Pour constater le résultat des effets vidéo : Choisissez Plan > Afficher l’animation vidéo (ou 
appuyez sur Contrôle + V).
• Pour constater le résultat des effets audio : choisissez Plan > Afficher l’animation audio (ou 
appuyez sur Contrôle + A).
2 Dans l’éditeur d’animation vidéo ou dans l’éditeur d’animation audio, faites glisser les effets pour 
en modifier l’ordre.
Les effets intégrés 
et l’étalonnage ne 
peuvent pas être 
réorganisés.
Faites glisser les 
effets de plan pour 
les réorganiser.
Copie d’effets et d’attributs entre des plans
Final Cut Pro propose deux façons de copier des effets entre les plans. La commande Coller les 
attributs vous permet de copier les attributs de plan sélectionnés à un autre plan et offre un 
contrôle supplémentaire sur les différents effets, réglages et images clés. La commande Coller 
les effets vous permet de copier tous les effets d’un plan vers un autre plan. Elle s’avère être le 
moyen le plus rapide pour copier des effets et des attributs.
Copie des attribut d’un plan sélectionné vers un autre
Vous pouvez copier les attributs, tels que les réglages et les effets, d’un plan à l’autre. Par 
exemple, il vous est possible de copier les réglages de rognage vidéo ou tout autre effet ajouté à 
un plan, y compris des réglages d’image clé quelconques.
La fonctionnalité Coller les attributs vous permet de sélectionner les attributs de plan 
à appliquer.
1 Sélectionnez un plan dans la timeline, puis choisissez Édition > Copier (ou appuyez sur 
Commande + C).
2 Sélectionnez le ou les plans auxquels vous souhaitez appliquer les attributs, puis choisissez 
Édition > Coller les attributs (ou appuyez sur Commande + Maj +V).
3 Effectuez l’une des opérations suivantes:
• Pour appliquer tous les attributs vidéo ou audio du plan source : cochez la case Attributs vidéo ou 
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• Pour appliquer des attributs précis: cochez la case de chaque attribut à appliquer.
4 Si vous apportez un réglage quelconque aux images clés du plan source, choisissez Conserver 
la synchronisation ou Adapter par étirement à partir du menu local Images clés. Si vous choisissez Adapter par étirement, Final Cut Pro adapte les images clés dans le temps pour respecter la 
durée du plan de destination.
5 Cliquez sur Coller.
Copie de tous les effets d’un plan vers un autre
1 Dans la timeline, sélectionnez le plan duquel copier les effets, puis sélectionnez Édition > copier 
(ou appuyez sur Commande + C).
2 Sélectionnez le ou les plans auxquels vous souhaitez appliquer les effets, puis choisissez Édition > 
Coller les effets (ou appuyez sur Commande +Option +V).
Les effets du plan source et leurs réglages s’appliquent alors au plan de destination. Pour béné-
ficier d’un plus grand contrôle sur les différents attributs, suivez les instructions dans la section 
« Copie des attribut d’un plan sélectionné vers un autre » ci-avant.
Désactivation ou suppression d’un effet d’un plan
Lorsque vous appliquez un effet à un plan, il vous est possible soit de désactiver l’effet (tout en 
conservant ses réglages), soit de le supprimer du plan.
Désactivation d’un effet de plan
1 Sélectionnez dans la timeline un plan incluant un effet.
2 Procédez de l’une des manières suivantes:
• Choisissez Plan > Afficher l’animation vidéo (ou appuyez sur Contrôle +V) pour voir les effets 
vidéo, ou choisissez Plan > Afficher l’animation audio (ou appuyez sur Contrôle + A) pour voir 
les effets audio. Sélectionnez l’effet, puis cliquez sur sa case.
• Sélectionnez l’effet dans l’inspecteur vidéo ou dans l’inspecteur audio, puis cliquez sur sa 
case bleue.
L’effet ne s’applique plus à la vidéo ou à l’audio. Vous pouvez cliquer sur la case pour réactiver 
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Suppression d’un effet d’un plan
1 Sélectionnez dans la timeline un plan incluant un effet.
2 Procédez de l’une des manières suivantes:
• Choisissez Plan > Afficher l’animation vidéo (ou appuyez sur Contrôle +V) pour voir les effets 
vidéo, ou choisissez Plan > Afficher l’animation audio pour voir les effets audio. Sélectionnez 
l’effet, puis appuyez sur Supprimer.
• Sélectionnez à l’effet dans l’inspecteur vidéo ou dans l’inspecteur audio.
Création de versions d’effets vidéo spécialisées dans Motion
De nombreux effets vidéo fournis ont été élaborés dans Motion, une application Apple conçue 
pour fonctionner avec Final Cut Pro. Vous pouvez ouvrir ces effets dans Motion, y apporter des 
modifications et enregistrer ces modifications sous forme de nouvel effet qui s’affiche ensuite 
dans le navigateur d’effets.
Important : Les étapes suivantes impliquent que Motion 5 soit installé sur votre ordinateur.
Modification d’un effet vidéo dans Motion
1 Dans la barre d’outils, cliquez sur le bouton Effets.
2 Dans le navigateur d’effets, cliquez sur l’effet tout en maintenant la touche Contrôle enfoncée, 
puis choisissez «Ouvrir une copie dans Motion » dans le menu contextuel.
Motion se lance automatiquement et ouvre le projet de l’effet.
3 Modifiez le projet de l’effet.
Pour en savoir plus, consultez l’Aide Motion à l’adresse http://help.apple.com/motion.
4 Choisissez Fichier > Enregistrer sous (ou appuyez sur Commande + Maj + S), attribuez un nom au 
nouvel effet (appelé modèle dans Motion), affectez-le à une catégorie (ou créez-en une), choisissez un thème (le cas échéant), puis cliquez sur Publier.
Remarque : Si vous choisissez Fichier > Enregistrer, l’effet s’enregistre alors en reprenant le même 
nom complété du suffixe « copie ».
Ajout de générateurs
Présentation des générateurs
Final Cut Pro comprend une série de plans vidéo, appelés générateurs, pour une panoplie étendue d’usages dans un projet. Par exemple, vous pouvez faire appel aux générateurs pour ajouter 
les éléments suivants:
• Contenu de repère d’emplacement: si du contenu est absent du projet car il n’a pas encore été 
filmé ou remis, vous pouvez ajouter un plan repère d’emplacement. Le générateur de repère 
d’emplacement vous permet d’ajouter un plan à la timeline avec une silhouette adaptée 
pour représenter le contenu manquant. Consultez Utilisation d’un repère d’emplacement à la 
page 247.
• Compteur de timecode : vous avez la possibilité d’ajouter à votre projet un plan de timecode 
pour superposer un compteur de timecode généré sur une partie ou l’intégralité du projet. 
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• Plan de forme : vous avez le choix parmi une grande variété de formes pour ajouter des élé-
ments graphiques au projet. Consultez Utilisation d’une forme à la page 248.
• Plan d’arrière-plan général : Final Cut Pro inclut un grand choix d’arrière-plans fixes et animés 
sur lesquels vous pouvez superposer des titres ou des effets d’incrustation. Consultez 
Utilisation d’un arrière-plan à la page 249.
Tous les générateurs s’ajoutent au projet sous forme de plans dont la durée est définie d’entrée 
par défaut. Vous pouvez modifier cette durée et la position de façon identique à tout autre plan 
vidéo sur la timeline.
Remarque : Les plans générateurs n’apparaissent pas dans le navigateur d’effets.
Utilisation d’un repère d’emplacement
Les repères d’emplacement générés s’avèrent utiles dans de nombreux cas de figure où il 
convient de remplir un vide dans le projet par quelque chose fournissant un indice sur ce que le 
contenu final est appelé à inclure. Vous pouvez configurer les plans repère d’emplacement pour 
représenter un large éventail de plans standard, tels que des gros plans, des groupes, des plans 
élargis, etc.
Insertion et configuration d’un plan repère d’emplacement
1 Dans la timeline, positionnez la tête de lecture sur le point où vous comptez ajouter le plan 
repère d’emplacement.
2 Procédez de l’une des manières suivantes:
• Choisissez Édition > Insérer le repère d’emplacement.
• Ouvrez le navigateur de générateurs en cliquant sur le bouton Générateurs repris sur la barre 
d’outils, puis double-cliquez sur la vignette intitulée Repère d’emplacement.
3 Sélectionnez un plan repère d’emplacement sur la timeline.
4 Configurez la prise de vue pour le plan à représenter à l’aide des réglages de l’inspecteur 
du générateur.
5 Sélectionnez Afficher les notes pour ajouter une zone de texte dans le visualiseur où il vous est 
possible de saisir du texte appartenant au plan en question.
Si vous préférez remplir un vide sur la timeline par un plan vierge, vous pouvez insérer un espace. 
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Usage d’un compteur de timecode
Lors de l’envoi du projet pour le faire passer en revue, il peut s’avérer utile d’y superposer le timecode, simplifiant ainsi la tâche au réviseur pour indiquer précisément les sections afin de faire 
part de commentaires.
Insertion et configuration d’un compteur de timecode
1 Ouvrez le navigateur de générateurs en cliquant sur le bouton Générateurs repris sur la barre 
d’outils.
2 Faites glisser le générateur de timecode au-dessus du scénario principal.
Le plan du générateur de timecode est généralement placé au début du projet, mais il vous 
est possible de le placer n’importe où vous voulez qu’il apparaisse puis adapter sa durée à celle 
du projet.
3 Configurez les réglages de timecode dans l’inspecteur du générateur.
Vous pouvez cliquer sur le bouton Réinitialiser pour rétablir les réglages par défaut 
du générateur.
Utilisation d’une forme
Vous pouvez configurer le générateur de formes afin qu’il s’adapte à n’importe quelle forme 
parmi celles proposées, telle qu’une étoile, un losange, une flèche et un cœur. Il s’agit ici de celles 
utilisées le plus souvent au-dessus du scénario principal pour ajouter un élément graphique au 
projet qu’il vous est ensuite possible d’animer.
Insertion et configuration d’une forme
1 Ouvrez le navigateur de générateurs en cliquant sur le bouton Générateurs repris sur la barre 
d’outils.
2 Faites glisser le générateur de formes au-dessus du scénario principal afin qu’il vienne se positionner par dessus le plan vidéo sur lequel vous voulez que la forme apparaisse.
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3 Dans le menu local Forme de l’inspecteur du générateur, choisissez la forme à utiliser.
4 Définissez la couleur de remplissage, la couleur et la largeur du contour, ainsi que l’ombre portée 
de la forme.
Vous pouvez cliquer sur le bouton Réinitialiser pour rétablir les réglages par défaut 
du générateur.
5 Pour adapter la taille, la position et la rotation de la forme, faites appel à l’effet intégré 
Transformer ou Distorsion.
Utilisez l’effet Transformer pour 
modifier la taille, la position et la 
rotation de la forme.
Grâce à ces effets, il vous est également possible d’animer la forme. Par exemple, vous pouvez 
faire suivre une personne dans une salle par une flèche.
6 Pour rendre la forme partiellement transparente, sélectionnez-la dans la timeline, puis ajustez son 
réglage Opacité dans l’inspecteur vidéo.
Utilisation d’un arrière-plan
De nombreux générateurs prévoient un arrière-plan à caractère général sur lequel il vous est 
possible de placer des effets intégrés, des titres, des incrustations et des plans avec un canal 
alpha. Certains se composent de simples couleurs unies, d’autres représentent des textures telles 
que du bois ou de la pierre. Des générateurs contiennent même des animations, proposant ainsi 
un arrière-plan plus attractif.
Insertion et configuration d’un plan d’arrière-plan
1 Dans la timeline, positionnez la tête de lecture sur le point où vous comptez ajouter le plan 
d’arrière-plan.
2 Ouvrez le navigateur de générateurs en cliquant sur le bouton Générateurs repris sur la barre 
d’outils.
3 Dans le navigateur de générateurs, double-cliquez sur la vignette représentant l’arrière-plan 
à utiliser.
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5 Configurez l’arrière-plan (le cas échéant) à l’aide des réglages repris dans l’inspecteur 
du générateur.
Création de versions de générateurs spécialisées dans Motion
De nombreux générateurs ont été élaborés dans Motion, une application Apple conçue pour 
fonctionner avec Final Cut Pro. Pour les personnaliser davantage, vous pouvez les ouvrir dans 
Motion, apporter des modifications et enregistrer ces dernières sous forme de nouveau fichier 
qui apparaît ensuite dans le navigateur de générateurs.
Important : Les étapes suivantes impliquent que Motion 5 soit installé sur votre ordinateur.
Modification d’un générateur ou d’un arrière-plan dans Motion
1 Ouvrez le navigateur de générateurs en cliquant sur le bouton Générateurs repris sur la barre 
d’outils.
2 Dans le navigateur de générateurs, cliquez sur une vignette en maintenant la touche Contrôle 
enfoncée, puis choisissez «Ouvrir une copie dans Motion » dans le menu contextuel.
Motion se lance automatiquement et ouvre le projet du plan.
3 Modifiez le projet du plan.
Pour en savoir plus, consultez l’Aide Motion à l’adresse http://help.apple.com/motion.
4 Choisissez Fichier > Enregistrer sous (ou appuyez sur les touches Commande + Maj + S), attribuez un nom au nouveau générateur, puis cliquez sur Enregistrer.
Remarque : Si vous choisissez Fichier > Enregistrer, le générateur s’enregistre alors en reprenant 
le même nom complété du suffixe « copie ».
À propos des thèmes
Final Cut Pro comprend un certain nombre de générateurs, de transitions et de titres, groupés 
par thème. Les générateurs, les transitions et les titres de chaque thème utilisent des formes et 
des couleurs proches, offrant un style visuel unique à chacun des thèmes.
Les noms de thème, tels que Boîtes, Bande dessinée ou Documentaire, suggèrent des éléments 
qu'ils utilisent ou le type de projet dans lequel il peut être utilisé. Chaque thème peut contenir 
plusieurs générateurs vidéo, transitions vidéo et titres.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 251
Pour accéder au navigateur de thèmes, cliquez sur le bouton Thèmes de la barre d’outils.
Pour en savoir plus sur les générateurs vidéo, consultez la section Présentation des générateurs à 
la page 246.
Pour en savoir plus sur les transitions vidéo, consultez la section Présentation des transitions à la 
page 213.
Pour en savoir plus sur les titres, consultez la section Présentation des titres à la page 222.
Usage des commandes à l’écran
Présentation des commandes à l’écran
De nombreux effets, transitions et autres éléments font appel à des commandes à l’écran, placées 
au premier plan de la vidéo reprise dans le visualiseur, afin de simplifier l’ajustement d’un grand 
nombre de paramètres. Dans de nombreux cas, ces commandes à l’écran recopient les commandes reprises dans les inspecteurs, bien que dans certains cas les commandes soient uniques 
et constituent le seul moyen de régler un paramètre donné.
Ces commandes peuvent se limiter à la simple définition du centre d’un effet de loupe ou 
s’étendre au réglage plus complexe du diamètre, de la largeur et de l’emplacement d’un effet 
de vignette.
Cette section se concentre sur les types de commandes à l’écran que l’on retrouve dans les effets 
et les transitions de plans. Ces commandes sont également proposées dans d’autres parties de 
Final Cut Pro, notamment les suivantes:
• Effets intégrés: les commandes à l’écran s’avèrent particulièrement utiles pour tous les effets 
intégrés. Consultez Présentation des effets intégrés à la page 228.
• Incrustation colorimétrique : des commandes à l’écran spécialisées vous sont proposées lors de 
la configuration d’un incrustateur colorimétrique. Consultez Utilisation des incrustations chromatiques à la page 348.
• Étalonnages: les étalonnages prévoient parfois des commandes à l’écran afin de créer des 
masques de couleurs et de formes. Consultez Présentation de l’étalonnage manuel à la 
page 375.
Affichage ou masquage des commandes à l’écran
Les commandes à l'écran des transitions s'affichent lorsqu'une transition est sélectionnée. Les 
commandes à l'écran des effets de plan s'affichent lorsqu'un effet est sélectionné ou lorsque la 
tête de lecture est positionnées sur un plan ou un titre dans la timeline à laquelle un effet vidéo 
est appliqué. Vous pouvez aussi afficher ou masquer les commandes à l'écran.
Remarque : Les commandes à l’écran se masquent toujours lorsque vous lancez la lecture de 
plans dans la timeline.
Affichage ou masquage des commandes à l’écran d’une transition
m Pour afficher les commandes à l’écran de la transition : sélectionnez la transition dans la timeline.
m Pour masquer les commandes à l’écran de la transition : désélectionnez la transition sur la timeline.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 252
Affichage ou masquage des commandes à l’écran de l’effet d’un plan
m Pour afficher les commandes de l’effet: placez la tête de lecture sur un plan avec l'effet ou sélectionnez un plan avec l'effet dans la timeline, puis sélectionnez l'effet dans l'éditeur d'animation 
vidéo ou dans l'inspecteur vidéo.
m Pour masquer les commandes à l’écran de l’effet: désélectionnez le plan incluant l’effet sur la timeline ou désélectionnez l’effet soit dans l’éditeur d’animation vidéo, soit dans l’inspecteur vidéo.
Remarque : Si un plan contient plusieurs effets utilisant des commandes à l'écran, seules celles 
de l'effet situé le plus haut s'affichent lorsque la tête de lecture est positionnée sur le plan contenant les effets.
Exemples de commandes à l’écran
Ces quelques exemples de commandes à l’écran ci-dessous peuvent s’avérer utiles au moment 
de manipuler des effets de plans et des transitions. De nombreux autres effets de plans et transitions s’appuient sur ces commandes ou des commandes semblables (les exemples ci-après 
sont prévus dans le but de fournir des informations à caractère général sur l’utilisation des commandes à l’écran).
N’oubliez pas les points ci-dessous en suivant ces exemples:
• Ces derniers partent du principe que vous êtes familier de l’application d’effets aux plans dans 
la timeline.
• S’il vous est possible d’appliquer plusieurs effets à un même plan, il est recommandé dans le 
cadre de ces exemples soit d’appliquer chaque effet à un plan différent sur la timeline, soit de 
supprimer l’effet du plan voulu avant d’appliquer un autre effet.
• Ces exemples partent en outre du principe que vous savez ajouter des transitions à des points 
de montage dans la timeline.
• La plupart des effets et des transitions possèdent des ajustements complémentaires dans l’inspecteur vidéo ou dans l’inspecteur de transition.
Exemple : Usage des commandes à l’écran pour appliquer un effet Capteur
1 Ouvrez le navigateur d’effets et faites glisser l’effet Capteur sur un plan de la timeline.
2 Pour régler les commandes à l’écran de l’effet, effectuez l’une des opérations suivantes:
• Pour positionner l’effet: faites glisser le cercle central.
• Pour définir la taille de l’effet: faites glisser le cercle extérieur.
Faites glisser le cercle central 
pour positionner l’effet.
Faites glisser le cercle pour 
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Exemple : Usage des commandes à l’écran pour appliquer un effet Gouttelette
1 Ouvrez le navigateur d’effets et faites glisser l’effet Gouttelette sur un plan de la timeline.
2 Pour régler les commandes à l’écran de l’effet, effectuez l’une des opérations suivantes:
• Pour positionner l’effet: faites glisser le cercle central.
• Pour définir la limite extérieure de l’effet: faites glisser le cercle extérieur.
• Pour définir la limite intérieure de l’effet: faites glisser le cercle intérieur.
• Pour définir la taille globale de l’effet: faites glisser n’importe quelle zone entre les cercles inté-
rieur et extérieur. Une zone en relief apparaît lorsque le pointeur se place dessus.
Faites glisser le cercle central 
pour positionner l’effet.
Faites glisser la zone (grisée) 
délimitée par les cercles pour 
définir l’étendue de l’effet global.
Faites glisser le cercle intérieur 
pour régler la limite intérieure.
Faites glisser le cercle extérieur 
pour régler la limite extérieure.
Exemple : Usage des commandes à l’écran pour appliquer un effet Prisme
1 Ouvrez le navigateur d’effets et faites glisser l’effet Prisme sur un plan de la timeline.
2 Pour indiquer la direction de l’effet, faites glisser la flèche. 
L’effet ne prévoyant aucun centre défini, le cercle central ne peut pas être glissé.
Faites glisser la flèche pour 
indiquer la direction de l’effet.
Le cercle central ne peut 
pas être glissé car l’effet ne 
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Exemple : Usage des commandes à l’écran pour appliquer un effet Étalement
1 Ouvrez le navigateur d’effets et faites glisser l’effet Étalement sur un plan de la timeline.
2 Pour régler les commandes à l’écran de l’effet, effectuez l’une des opérations suivantes:
• Pour positionner l’effet: faites glisser le cercle central.
• Pour définir le sens de l’effet: faites glisser la poignée de rotation.
Faites glisser cette poignée 
pour faire pivoter la direction 
de l’effet.
Faites glisser le cercle central 
pour régler la position de 
départ de l’effet.
Exemple : Usage des commandes à l’écran pour appliquer une transition Centre
1 Ouvrez le navigateur de transitions et faites glisser la transition Centre sur un point de montage 
de la timeline.
2 Pour régler les commandes à l’écran de la transition, effectuez l’une des opérations suivantes:
• Pour positionner la transition : faites glisser le cercle central.
• Pour définir le sens de la transition : faites glisser la flèche.
• Pour régler l’épaisseur de la bordure de la transition (effet d’adoucissement dans ce cas): faites glisser la poignée extérieure par rapport au cercle central.
Faites glisser la flèche pour indiquer 
la direction de la transition.
Faites glisser le cercle central 
pour positionner la transition.
Faites glisser cette poignée pour définir 
la largeur de la bordure (ici, il s’agit 
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Exemple : Usage des commandes à l’écran pour appliquer une transition Étoile
1 Ouvrez le navigateur de transitions et faites glisser la transition Étoile sur un point de montage 
de la timeline.
2 Pour régler les commandes à l’écran de la transition, effectuez l’une des opérations suivantes:
• Pour positionner la transition : faites glisser le cercle central.
• Pour définir le nombre de points de l’étoile : faites glisser la poignée la plus longue.
• Pour faire pivoter l’étoile : faites glisser la poignée la plus courte.
Faites glisser le cercle central pour 
régler la position de la transition.
Faites glisser cette poignée pour définir 
le nombre de branches de l’étoile.
Faites glisser cette poignée pour faire 
pivoter l’étoile de transition.
Exemple : Usage des commandes à l’écran pour appliquer une transition Zoom et 
panoramique
1 Ouvrez le navigateur de transitions et faites glisser la transition Zoom et panoramique sur un 
point de montage de la timeline.
2 Pour régler les commandes à l’écran de la transition, effectuez l’une des opérations suivantes:
• Pour définir le point de départ de la transition : faites glisser le cercle vert.
• Pour définir le point d’arrivée de la transition : faites glisser le cercle rouge.
Faites glisser le cercle rouge 
pour définir le point d’arrivée.
Faites glisser le cercle 
vert pour régler le point 
de départ.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 256
Utilisation de l’éditeur d’animation vidéo
Présentation de l’animation vidéo
Grâce à Final Cut Pro, vous pouvez créer des variations simples de la vidéo au cours de la lecture, 
telles que le fondu entrant progressif de la vidéo au début d’un film. Vous avez également la possibilité de réaliser des ajustements sophistiqués et précis dans le temps pour de nombreux paramètres d’effets vidéo différents, de transitions, de trajectoires d’animation, etc.
Final Cut Pro prévoit des images clés et des poignées de fondu dans l’éditeur d’animation vidéo 
pour vous permettre de faire évoluer les effets au gré de la lecture.
Le terme image clé est issu de l’animation traditionnelle, où seules les images importantes (clés) 
d’une séquence animée étaient dessinées pour esquisser l’animation d’un personnage au fil 
du temps. Une fois les images clés déterminées, un artiste d’interpolation dessine toutes les 
images intermédiaires.
Dans Final Cut Pro, vous pouvez régler des paramètres sur des valeurs spécifiques à des moments 
précis (représentés par des images clés) et laisser Final Cut Pro jouer le rôle du graphiste chargé de 
l’interpolation en temps réel, en calculant toutes les valeurs intermédiaires entre vos images clés. 
Par exemple, pour animer un paramètre, tel qu’un réglage de rotation ou de mise à l’échelle, vous 
devez créer au moins deux images clés dans le plan. Final Cut Pro déduit la valeur du réglage entre 
les images clés, créant ainsi une animation fluide au fur et à mesure des fluctuations du réglage.
Vous pouvez animer normalement ou avec des images clés aussi bien des effets vidéo qu’audio 
dans Final Cut Pro, notamment les différents paramètres d’effets et les propriétés des plans. Pour 
en savoir plus sur l’animation audio avec des images clés, consultez Ajustement des effets audio à 
l’aide d’images clés à la page 200.
Ajustement d’effets vidéo à l’aide d’images clés
Vous devez dans ce cas placer des images clés à des points spécifiques d’un plan pour modifier les 
valeurs des paramètres au niveau de ces points. 
Par exemple, si vous souhaitez qu’un plan de votre projet se fonde jusqu’à se noircir complètement, vous devez définir deux images clés d’opacité à deux instants différents: l’un avec une 
valeur de 100 (entièrement visible) et l’autre avec une valeur de 0 (complètement transparent). 
Final Cut Pro interpole les valeurs intermédiaires entre 100 et 0, ce qui crée un fondu en douceur 
vers le noir.
Il est possible de définir des images clés sur la timeline ou dans l’inspecteur vidéo. Pour localiser les images clés sur la timeline, vous devez afficher l’éditeur d’animation vidéo pour le plan 
en question.
Des commandes d’images clés supplémentaires apparaissent avec les effets intégrés de 
Final Cut Pro. Consultez Manipulation d’effets intégrés à la page 235.
Pour en savoir plus sur les images clés appliquées à des clips audio, consultez Ajustement des 
effets audio à l’aide d’images clés à la page 200.
Ajout d’images clés
1 Procédez de l’une des manières suivantes:
• Sélectionnez un plan dans la timeline, puis choisissez Plan > Afficher l’animation vidéo (ou 
appuyez sur Contrôle +V).
• En maintenant la touche Contrôle enfoncée, cliquez sur un plan dans la timeline, puis choisissez 
« Afficher l’animation vidéo » dans le menu contextuel. Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 257
Dans l’éditeur d’animation vidéo, chaque effet possède une zone séparée pour l’ajout 
d’images clés.
Certains effets possèdent plusieurs paramètres et vous permettent d’ajouter des images clés 
indépendamment aux différents paramètres. Dans l’éditeur d’animation vidéo, ils apparaissent 
avec un triangle en regard du nom de l’effet et dans l’inspecteur vidéo sous forme de commandes de paramètre supplémentaires.
2 Sélectionnez l’effet auquel vous souhaitez ajouter des images clés dans l’éditeur d’animation 
vidéo ou dans la section Effets de l’inspecteur vidéo.
3 Procédez de l’une des manières suivantes:
• Pour développer les paramètres dans l’éditeur d’animation vidéo : cliquez sur le triangle pour 
choisir un paramètre précis dans le menu local, ou sélectionnez Tous pour ajouter des images 
clés à tous les paramètres.
• Pour développer les paramètres dans l’inspecteur vidéo : cliquez sur Afficher lorsque vous placez 
le pointeur sur l’effet et qu’apparaît l’option.
4 Effectuez l’une des opérations suivantes pour chaque effet :
• Dans l’éditeur d’animation vidéo : tout en maintenant la touche Option enfoncée, cliquez sur un 
point de la commande horizontale de l’effet où vous souhaitez ajouter l’image clé (ou appuyez 
sur Option + K).
Les images clés pour le paramètre choisi s’affichent sous forme de losanges blancs, alors que 
celles des autres paramètres apparaissent en gris.
Image clé du paramètre 
sélectionnéChapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 258
Si vous choisissez d’afficher tous les paramètres dans l’éditeur d’animation vidéo, les images 
clés s’affichent sous forme de losanges blancs pour tous les paramètres. Une paire de losanges 
indique que vous avez ajouté des images clés à plusieurs paramètres au point indiqué.
Double losange
• Dans l’inspecteur vidéo : placez la tête de lecture dans la timeline à l’endroit où vous souhaitez 
ajouter une image clé, puis cliquez sur le bouton Image clé (ou appuyez sur Option + K).
Une fois l’image clé ajoutée, le bouton Image clé devient jaune, indiquant que la tête de lecture est positionnée sur une image clé.
Bouton 
d’image clé
Lorsque vous déplacez la tête de lecture sur la timeline, des flèches s’affichent à côté du 
bouton Image clé dans l’inspecteur vidéo pour indiquer de quel côté de la tête de lecture des 
images clés sont placées. Pour revenir à l’image clé précédente, cliquez sur la flèche gauche ou 
appuyez sur Option + Point-virgule (;). Pour passer à l’image clé suivante, cliquez sur la flèche 
droite ou appuyez sur Option + apostrophe (’).
Flèches
5 Ajoutez des images clés si nécessaire.
Conseil : après avoir ajouté une image clé, il vous est possible d’en ajouter une autre automatiquement en déplaçant la tête de lecture sur la timeline, puis en ajustant la valeur de paramètre 
de l’effet dans l’inspecteur vidéo.
Ajout automatique d’images clés sur une zone sélectionnée
Si un effet est assorti d’un triangle d’affichage dans l’éditeur d’animation vidéo, vous pouvez utiliser l’outil Sélectionner ou Sélection de plage pour ajouter automatiquement des images clés sur 
une zone sélectionnée.
1 Procédez de l’une des manières suivantes:
• Sélectionnez un plan dans la timeline, puis choisissez Plan > Afficher l’animation vidéo (ou 
appuyez sur Contrôle +V).
• En maintenant la touche Contrôle enfoncée, cliquez sur un plan, puis choisissez « Afficher l’animation vidéo » dans le menu contextuel. Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 259
2 Sélectionnez un effet, puis cliquez sur le triangle d’affichage pour le développer dans l’éditeur 
d’animation vidéo.
Triangle 
d’affichage
3 Dans la timeline, choisissez Sélectionner ou Sélection de plage dans le menu local Outils de la 
barre d’outils (ou appuyez sur la touche A pour Sélectionner ou sur la touche R pour Sélection 
de plage).
4 Faites glisser le curseur dans l’éditeur d’animation vidéo, sur la zone où vous souhaitez ajuster 
un effet.
5 Ajustez l’effet sur la plage en déplaçant verticalement la commande horizontale.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 260
Les images clés sont automatiquement créées le long des points d’ajustement dans la plage.
Ajustement des images clés dans l’éditeur d’animation vidéo
Vous pouvez déplacer horizontalement des images clés dans l’éditeur d’animation vidéo. Si un 
effet présente un triangle d’affichage, vous pouvez développer la présentation de l’effet et déplacer verticalement les images clés pour modifier la valeur du paramètre.
1 Sélectionnez une image clé.
2 Procédez de l’une des manières suivantes:
• Pour repositionner l’image clé dans l’éditeur d’animation vidéo, faites-la glisser vers la gauche 
ou la droite.
Ce faisant, la valeur de timecode apparaît.
Faites glisser 
horizontalement 
l’image clé.
• Si un effet présente un triangle d’affichage, cliquez sur ce dernier (ou double-cliquez sur l’effet) 
pour le développer.
Triangle 
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Une fois l’effet développé, vous pouvez faire glisser l’image clé verticalement pour modifier la 
valeur du paramètre de l’effet.
Conseil : pour régler les valeurs avec plus de précision, maintenez la touche Commande 
enfoncée tout en faisant glisser verticalement l’image clé.
Faites glisser verticalement 
l’image clé.
Pour ajouter une autre image clé, maintenez la touche Option enfoncée et cliquez (ou 
appuyez sur Option + K) sur la commande de l’effet à l’endroit où vous voulez ajouter 
l’image clé. Pour ajouter une image clé et modifier la valeur de paramètre de l’effet en une 
seule opération, maintenez la touche Option enfoncée, puis faites glisser la commande de 
l’effet verticalement.
Si un effet présente un triangle d’affichage dans l’éditeur d’animation vidéo, vous pouvez aussi 
appliquer un fondu entrant ou sortant aux effets vidéo ou faire évoluer la forme de la courbe de 
l’effet d’une image clé à l’autre.
Ajustement des images clés dans l’inspecteur vidéo
Pour de nombreux effets, vous pouvez ajuster la valeur du paramètre des différentes images clés 
à l’aide de l’inspecteur vidéo.
Lorsque vous déplacez la tête de lecture sur la timeline, des flèches s’affichent à côté du bouton 
Image clé dans l’inspecteur vidéo pour indiquer de quel côté de la tête de lecture des images 
clés sont placées. Pour revenir à l’image clé précédente, cliquez sur la flèche gauche ou appuyez 
sur Option + Point-virgule (;). Pour passer à l’image clé suivante, cliquez sur la flèche droite ou 
appuyez sur Option + apostrophe (’).
Flèches
1 Sélectionnez ou placez la tête de lecture sur une image clé, puis ajustez la valeur du paramètre 
dans l’inspecteur vidéo.
2 Pour modifier la valeur de l’image clé suivante, accédez à celle-ci et ajustez à nouveau sa valeur.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 262
Affichage d’un seul effet à la fois dans l’éditeur d’animation vidéo
Vous pouvez condenser l’éditeur d’animation vidéo pour afficher un seul effet à la fois. Cela peut 
être utile si vous appliquez plusieurs effets à un plan et que vous souhaitez conserver de l’espace 
à l’écran.
1 Choisissez Plan > Solo de l’animation (ou appuyez Maj + Contrôle +V).
2 Dans l’éditeur d’animation vidéo, cliquez sur le triangle en regard du nom de l’effet pour choisir 
un effet dans le menu local.
Remarque : Lorsque l’option « Solo de l’animation » est activée, vous ne pouvez pas supprimer 
d’effet depuis l’éditeur d’animation vidéo.
Pour désactiver « Solo de l’animation », choisissez Plan > Solo de l’animation (ou appuyez sur 
Maj + Contrôle +V).
Suppression d’images clés
Procédez de l’une des manières suivantes:
m Sélectionnez une image clé dans l’éditeur d’animation vidéo et appuyez sur la touche Supprimer.
m Accédez à une image clé dans l’inspecteur vidéo, puis cliquez sur le bouton Image clé.
Une fois atteint une 
image clé, cliquez sur 
le bouton d’image clé 
pour la supprimer.
Masquage de l’animation vidéo pour un plan
Procédez de l’une des manières suivantes:
m Sélectionnez le plan dans la timeline, puis choisissez Plan > Masquer l’animation vidéo (ou 
appuyez sur Contrôle +V).
m Cliquez sur le bouton de fermeture situé dans l’angle supérieur gauche de l’éditeur 
d’animation vidéo.
m En maintenant la touche Contrôle enfoncée, cliquez sur le plan dans la timeline, puis choisissez 
« Masquer l’animation vidéo » dans le menu contextuel.
Ajustement des courbes d’effet à l’aide des poignées de fondu ou d’une 
animation avec des images clés
Dans l’éditeur d’animation vidéo, certains effets comprennent des poignées de fondu permettant 
d'ajuster la durée du fondu entrant ou sortant d'un effet. Par exemple, vous pouvez utiliser les 
poignets de fondu pour ajuster la durée du fondu entrant de l'effet d'opacité, du fondu à l'ouverture depuis le noir ou du fondu au noir.
Vous pouvez aussi déplacer les images clés verticalement pour créer une courbe destinée au 
paramètre de l’effet et modifier la forme de la courbe (interpolation) passant par les images clés.
Créer ainsi une courbe de fondu ou d’effet adoucit la transition de sorte que les variations de 
l’effet semblent plus naturelles lors de la lecture du plan.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 263
Modification d’un effet à l’aide des poignées de fondu
1 Cliquez sur le triangle d’affichage pour développer l’effet dans l’éditeur d’animation vidéo.
Triangle 
d’affichage
Remarque : Si un effet ne possède aucun triangle d’affichage, il ne prévoit alors pas de poignée 
de fondu.
2 Faites glisser la poignée de fondu sur le point du plan où vous souhaitez que le fondu commence 
ou se termine.
Les poignées de fondu placées au début d’un plan créent un fondu entrant, tandis que celles placées à la fin d’un plan génèrent un fondu sortant.
Fondu entrant Fondu sortant
Modification d’un effet à l’aide d’images clés 
m Cliquez sur le triangle d’affichage pour développer l’effet dans l’éditeur d’animation vidéo.
Triangle 
d’affichage
Remarque : Si un effet ne possède aucun triangle d’affichage, il ne vous est alors pas possible de 
déplacer verticalement les images clés.
• Pour ajouter une image clé : tout en maintenant la touche Option enfoncée, cliquez sur un point 
de la commande de l’effet où vous souhaitez ajouter l’image clé (ou appuyez sur Option + K).
Conseil : Pour ajouter une image clé et modifier la valeur de paramètre de l’effet en une 
seule opération, maintenez la touche Option enfoncée, puis faites glisser la commande de 
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• Pour modifier la valeur de paramètre de l’effet au niveau d’une image clé donnée : sélectionnez 
une image clé, puis faites-la glisser verticalement.
Conseil : pour régler les valeurs avec plus de précision, maintenez la touche Commande 
enfoncée tout en faisant glisser verticalement l’image clé.
Faites glisser verticalement 
l’image clé.
Modification de la forme de la courbe (interpolation) passant par les images clés
Procédez de l’une des manières suivantes:
m Faites glisser horizontalement la ligne entre les images clés pour créer une courbe.
Pour ajuster la courbe avec plus de précision, maintenez la touche Commande enfoncée tout en 
faisant glisser verticalement le pointeur.
m Tout en appuyant sur la touche Contrôle, cliquez sur la ligne passant par les images clés, puis 
choisissez une option de courbe dans le menu contextuel.
• Linéaire : maintient une vitesse de changement constante sur toute la durée du fondu.
• Fluide : atténue en entrée et en sortie le fondu d’après le point intermédiaire défini entre les 
valeurs de début et de fin.
• Atténuation en entrée : commence lentement depuis la valeur de début, puis accélère progressivement vers la valeur de fin.
• Atténuation en sortie : commence rapidement depuis la valeur de début, puis ralentit progressivement vers la valeur de fin.Chapitre 10 Ajout de transitions, de titres, d’effets et de générateurs 265
Remarque : Vous pouvez modifier la forme de la courbe entre les images clés pour les effets 
vidéo uniquement. Dans le cas d’une courbe se limitant au volume, vous avez la possibilité 
d’influer sur la forme de la courbe pour les fondus créés à l’aide des poignées de fondu mais pas 
pour les images clés. Consultez Application d’un fondu entrant ou sortant à l’audio à la page 181.
Réglage de toutes les images clés sur la courbe
m Maintenez les touches Commande et Option enfoncées, puis faites glisser soit une image clé, soit 
la courbe complète verticalement.
Toutes les images clés sont alors ajustées de la même amplitude, préservant ainsi la forme d’origine de la courbe.
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Regroupement des plans et des plans composés
Présentation des plans composés
Avec Final Cut Pro, vous pouvez créer des plans composés, qui vous permettent de regrouper des 
plans de n’importe quels types dans la timeline ou le navigateur d’événements et d’imbriquer 
des plans dans d’autres plans. 
Un plan composé peut contenir des composants de plan vidéo et clip audio, des plans et 
d’autres plans composés. Chaque plan composé peut être considéré comme un mini-projet possédant ses propres propriétés. Les plans composés fonctionnent comme les autres plans: vous 
pouvez les ajouter à votre projet, leur appliquer un trim, les resynchroniser et leur ajouter des 
effets et des transitions. Des icônes identifient les plans composés dans le navigateur d’événements et la timeline. 
Icône de plan 
composé d’un plan 
dans le navigateur 
d’événements
Icône de plan 
composé d’un 
plan dans la 
timeline
Les plans composés se dénotent pour leurs nombreux usages. Vous pouvez :
• simplifier un projet complexe en créant un plan composé distinct pour chaque section 
principale ;
• synchroniser un plan vidéo un ou plusieurs clips audio, puis combiner les plans dans un plan 
composé, pour éviter de perdre par erreur leur synchronisation ;
• ouvrir n’importe quel plan, en modifier le contenu dans la timeline, puis le refermer ; 
• créer rapidement un plan composé contenant les plans d’un événement, dans l’ordre dans 
lequel ils apparaissent dans le navigateur d’événements;
• exploiter un plan composé pour créer une section d’un projet avec des réglages différents de 
ceux du projet principal.
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Le diagramme suivant illustre comment un projet peut être simplifié dans la timeline à l’aide de 
plans composés:
Plans sélectionnés dans la timeline 
Nouveau plan composé
Les plans composés présentent les caractéristiques suivantes:
• Vous pouvez créer des plans composés dans le navigateur d’événements ou dans la timeline. 
• Chaque plan composé dans la timeline possède un plan composé « parent » dans le navigateur 
d’événements.
Plans de l’événement
Projet 1 Projet 3
Plan enfant Plans enfants Plan enfant
Projet 2
Plan composé parent
• Lorsque vous modifiez le contenu d’un plan composé quelconque, vous montez en fait le 
plan composé parent depuis le navigateur d’événements. Toute modification apportée à un 
plan composé est transmise à l’intégralité de ses plans enfants. Par exemple, si vous supprimez un plan de titre du contenu d’un plan composé parent, il est alors supprimé de tous les 
plans enfants.
Vous pouvez créer un plan composé indépendant d’un plan composé existant. Par exemple, 
vous pouvez disposer d’un plan composé d’une séquence de titre standard pour vos séries télé-
visées ou vos podcasts. Vous pouvez créer des instances uniques (indépendantes) du plan composé pour chaque épisode sans affecter pour autant les autres instances de la séquence de titre. 
Remarque : Dans Final Cut Pro X, les plans composés offrent les mêmes fonctionnalités que les 
séquences imbriquées dans Final Cut Pro 7, mais avec plus de flexibilité et de convivialité.Chapitre 11 Montage avancé 268
Création et division de plans composés
Vous pouvez créer un plan composé à partir de plans existants dans la timeline ou le navigateur 
d’événements, ou bien créer un plan composé vide dans le navigateur d’événements et y ajouter 
des plans dans la timeline. Vous pouvez également scinder un plan composé ; ses différentes parties sont alors reconverties en éléments individuels dans la timeline.
Création d’un plan composé à partir de plans existants
1 Sélectionnez un ou plusieurs plans dans la timeline ou le navigateur d’événements.
Il peut s’agir de plans contigus ou non, de plans composés, de plans du scénario principal ou de 
plans connectés.
2 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Nouveau plan composé (ou appuyez sur Option + G).
• Cliquez sur la sélection tout en maintenant la touche ctrl enfoncée, puis choisissez Nouveau 
plan composé dans le menu contextuel.
Remarque : Lorsque vous ajoutez un plan composé à la timeline ou créez un plan composé à 
partir de plans existants dans la timeline, une relation directe et active s’établit entre un plan 
composé parent dans le navigateur d’événements et le plan composé enfant dans la timeline. Si 
le plan parent n’existe pas déjà dans le navigateur d’événements, Final Cut Pro en crée alors un 
automatiquement. Lorsque vous modifiez le contenu d’un plan composé (par exemple, en effectuant le trim de plans ou en ajoutant des effets à des plans inclus dans le plan composé), vous 
modifiez en fait toutes les instances du plan composé en question, y compris le plan composé 
parent dans le navigateur d’événements.Chapitre 11 Montage avancé 269
La façon dont les plans sont regroupés au sein du plan composé dépend de l’endroit où vous les 
avez sélectionnés:
• Si vous avez sélectionné les plans dans un événement: Final Cut Pro crée un plan composé dans 
l’événement (en plus des plans sélectionnés) et place des copies des plans sélectionnés horizontalement dans le nouveau plan composé, dans l’ordre dans lequel vous avez sélectionné 
les plans. (Pour obtenir des instructions complémentaires sur la création d’un plan composé 
dans le navigateur d’événements, consultez « Création d’un plan composé vide » ci-après.)
Plans sélectionnés dans le navigateur d’événements
Nouveau plan composé
Contenu du 
plan composéChapitre 11 Montage avancé 270
• Si vous avez sélectionné les plans dans la timeline : Final Cut Pro place les plans sélectionnés 
dans le nouveau plan composé exactement comme ils le sont dans la timeline. Le nouveau 
plan composé hérite de la taille d’image et de la fréquence d’images de la timeline actuelle.
Plans sélectionnés dans la timeline 
Nouveau plan composé
Contenu du 
plan composé
Création d’un plan composé indépendant d’un plan composé existant
1 Sélectionnez un plan composé dans la timeline.
2 Choisissez Plan > Référencer un nouveau plan parent.
Final Cut Pro crée un plan composé « parent » dans le navigateur d’événements. Cette commande rompt la relation entre le plan composé sélectionné dans la timeline et le plan composé 
parent d’origine qui lui correspond (ainsi que toute autre plan enfant du parent d’origine, dans 
tous les projets). 
Remarque : Vous pouvez également sélectionner plusieurs plans à l’étape 1 et laisser 
Final Cut Pro établir un ou plusieurs plans parents en s’appuyant sur les références de plan 
parent existantes.
Création d’un plan composé vide
Vous pouvez créer des plans composés vides puis y ajouter des plans. Chaque plan composé 
peut être considéré comme un mini-projet possédant ses propres propriétés.
1 Dans la bibliothèque d’événements, sélectionnez l’événement auquel vous voulez ajouter le 
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2 Choisissez Fichier > Nouveau plan composé.
Dans la fenêtre qui s’affiche, attribuez un nom au plan composé dans le champ Nom.
3 Cliquez sur « Utiliser les réglages personnalisés » pour personnaliser davantage les réglages pour 
votre plan composé.
Remarque : Final Cut Pro affiche les réglages automatiques par défaut, mais conserve en 
mémoire ceux que vous avez utilisés en dernier. Cette étape peut dès lors s’avérer facultative.
4 Par défaut, Final Cut Pro définit le champ Timecode de début à la valeur de timecode la plus 
faible pour les plans sélectionnés. Si vous voulez que le timecode du plan composé commence à 
une autre valeur, saisissez sa valeur dans le champ Timecode de début.
5 Pour modifier les réglages vidéo, audio et de rendu, cliquez sur Personnalisé. À moins que vous 
n’ayez des besoins précis pour le plan composé que vous créez, il est préférable de laisser les 
options «Définir automatiquement d’après le 1er plan vidéo » et « Utiliser les réglages par 
défaut » sélectionnées.
6 Cliquez sur OK.
Le nouveau plan composé apparaît dans l’événement.
Modification du contenu d’un plan standard dans la timeline
Vous pouvez modifier le contenu d’un plan standard.
m Sélectionnez un plan dans le navigateur d’événements ou la timeline, puis choisissez Plan > 
Ouvrir dans la timeline.
La timeline affiche le contenu du plan. La plupart des plans standard comprennent un composant vidéo et/ou un composant audio. Vous ne pouvez pas modifier le contenu de ces composants audio et vidéo.
Il vous est possible d’ajouter des données au contenu de ce plan (en ajoutant des plans à cette 
timeline). Pour fermer ce plan, accédez au niveau immédiatement supérieur dans l’historique de 
la timeline.
Remarque : Comme le montage effectué dans Final Cut Pro n’est pas destructif, toute modification apportée au contenu d’un plan standard ou composé n’a pas d’effet sur les fichiers d’origine 
qui demeurent intacts sur le disque dur de votre ordinateur. Pour en savoir plus sur la différence 
entre fichiers source et plans, consultez Fichiers de média et plans à la page 18.
Scinder des éléments de plan
Vous pouvez scinder un plan composé ou un plan standard pour convertir son contenu en plans 
individuels dans la timeline.
m Sélectionnez un plan composé ou un plan standard dans la timeline, puis choisissez Plan > 
Scinder les éléments de plan (ou appuyez sur cmd + Maj + G).
Final Cut Pro remplace le plan sélectionné dans la timeline par les différents éléments qui 
le constituent.
Si vous avez sélectionné un plan composé, les plans d’origine qui le constituaient sont rétablis. 
Cependant, le plan composé parent est conservé dans le navigateur d’événements.
Si le plan sélectionné est un plan standard, son contenu apparaît sous forme de plans individuels 
dans la timeline. La plupart des plans standard incluent un composant vidéo, un composant 
audio ou les deux. Les données audio apparaissent sous la forme d’un plan connecté.Chapitre 11 Montage avancé 272
Gestion des plans composés
Les plans composés peuvent être gérés et modifiés de diverses manières. Vous pouvez, par 
exemple, les ouvrir (et modifier leurs composants) dans une timeline distincte. Vous pouvez facilement parcourir les différents niveaux d’un plan composé. Enfin, vous pouvez ouvrir et modifier 
un plan composé au sein d’un événement.
Remarque : Lorsque vous modifiez le contenu d’un plan composé (par exemple, en effectuant le 
trim de plans ou en ajoutant des effets à des plans inclus dans le plan composé), vous modifiez 
en fait toutes les instances du plan composé en question, y compris le plan composé parent 
dans le navigateur d’événements. Toute modification apportée aux éléments intégrant le plan 
composé est transmise à l’intégralité de ses plans enfants, dans tous les projets. Ces modifications incluent entre autres l’ajout ou la suppression de plans, les réglages de trim, les effets 
vidéo ou audio tels que l’étalonnage, ou encore la resynchronisation de la vitesse des plans. Par 
exemple, si vous supprimez un plan de titre d’un plan composé parent, il est alors supprimé de 
tous les plans composés enfants.
Ouverture d’un plan composé en vue de sa modification
Procédez de l’une des manières suivantes:
m Sélectionnez un plan composé dans la timeline ou le navigateur d’événements, puis choisissez 
Plan > Ouvrir dans la timeline.
m Double-cliquez sur la partie vidéo d'un plan composé dans la timeline ou le navigateur 
d'événements.
m Cliquez sur l’icône de plan composé dans le coin supérieur gauche d’un plan composé dans 
la timeline.
Le plan composé s’ouvre dans une nouvelle timeline et son contenu peut être modifié.
Plan composé d’un projet dans la timeline
Plan composé ouvert dans une nouvelle vue de la timeline
Projet Plan composé
ProjetChapitre 11 Montage avancé 273
Remarque : Comme le montage effectué dans Final Cut Pro n’est pas destructif, toute modification apportée au contenu d’un plan standard ou composé n’a pas d’effet sur les fichiers d’origine 
qui demeurent intacts sur le disque dur de votre ordinateur. Pour en savoir plus sur la différence 
entre fichiers source et plans, consultez Fichiers de média et plans à la page 18.
Parcourir les niveaux d’un plan composé à l’aide de commandes de menu et de raccourcis clavier
Vous pouvez monter ou descendre d'un ou plusieurs niveaux dans un plan composé.
m Pour avancer (descendre d’un niveau): Choisir Présentation > Avancer dans l'historique de la timeline, ou appuyez sur Commande + Crochet fermant (])
m Pour reculer (monter d’un niveau): Choisir Présentation > Reculer dans l'historique de la timeline, 
ou appuyez sur Commande + Crochet ouvrant ([)
Parcourir les niveaux d’un plan composé à l’aide des boutons fléchés
Procédez de l’une des manières suivantes:
m Cliquez sur les flèches vers la gauche et la droite dans le coin supérieur gauche de la timeline.
m Cliquez sur la flèche droite ou gauche dans le coin supérieur gauche de la timeline et maintenez 
le bouton de la souris enfoncé, puis choisissez un niveau dans le menu local.
La flèche gauche permet de fermer le plan composé actuel et d’ouvrir son plan parent, le niveau 
supérieur étant le projet ou l’événement contenant le plan composé. S’il n’y a pas d’historique à 
parcourir, les flèches gauche et droite sont estompées. 
S’assurer que tout le contenu d’un plan composé apparaît dans la séquence
Lorsque vous montez le contenu d’un plan composé, Final Cut Pro indique la limite de ce dernier 
à l’aide d’une zone hachurée gris foncé à gauche de son point de départ et à droite de son point 
d’arrivée.
Si vous ajoutez des plans au contenu du plan composé, les parties de ces plans s’étendant dans 
la zone gris foncé n’apparaissent pas dans le projet.
Les plans figurant dans la zone hachurée 
gris foncé n’apparaissent pas dans la 
séquence finale.Chapitre 11 Montage avancé 274
Pour que les données des nouveaux plans apparaissent dans votre projet, effectuez l’une des 
opérations suivantes pour leur faire de la place :
m Réduisez la durée totale des autres plans du plan composé. Vous pouvez par exemple appliquer 
un trim à un ou plusieurs plans du plan composé.
m Fermez le plan composé pour remonter d’un niveau, puis augmentez la durée totale du plan 
parent (le « conteneur » du plan composé) dans la timeline.
Pour en savoir plus, consultez Présentation du trim à la page 130.
Ajout de scénarios
Les scénarios sont des séquences de plans connectés au scénario principal. Ils offrent à 
la fois la commodité des plans connectés et les possibilités de montage de précision du 
scénario principal.
Vous pouvez utiliser les scénarios pour les mêmes utilisations que les plans connectés (par 
exemple, créer des plans de coupe, composer des titres et autres graphismes ou encore ajouter 
des effets sonores et de la musique). 
L’avantage unique des scénarios réside dans la capacité à monter une suite de plans connectés 
dans le contexte des autres plans sur la timeline. Par exemple, il vous est possible d’ajouter des 
transitions en fondu croisé à une série de titres superposés dans un scénario, puis d’adapter le 
contrôle du temps des titres de sorte à les faire correspondre aux plans du scénario principal. 
Tout comme les plans connectés, les scénarios peuvent contenir aussi bien de la vidéo que de 
l’audio, ou se limiter à la vidéo seule et à l’audio. Pour plus d’informations sur les plans connectés, 
consultez Connexion de plans pour ajouter des prises, des titres et des effets de son synchronisés à la page 110.
Scénario
Scénario ne contenant que des données 
audio
Scénario principal
Pour monter les scénarios, vous pouvez utiliser les mêmes méthodes que pour le scénario principal. Vous pouvez : 
• Ajouter des plans: faites glisser des plans vers le scénario pour les ajouter, ou utilisez les commandes d’ajout, d’insertion, de remplacement et d’écrasement standard.Chapitre 11 Montage avancé 275
• Ajouter de transitions, des titres, des effets et des générateurs: ajoutez des effets à un scénario en 
les faisant glisser vers celui-ci ou en utilisant les commandes et les raccourcis clavier standard.
Remarque : Lorsque vous appliquez une transition à un plan connecté au scénario principal, 
un scénario est automatiquement créé pour ce plan.
• Appliquer un trim aux plans: utilisez les montages trim standard dans un scénario, notamment les montages Ripple, Roll, par coulissement et par glissement. Vous pouvez également 
appliquer un trim aux plans ou les déplacer au sein des scénarios en saisissant des valeurs 
de timecode.
• Créer des montages par chevauchement: définissez des points de départ et d’arrivée distincts 
pour les données vidéo et audio dans un plan particulier pour créer des montages scindés 
(coupes en L et en J) dans un scénario.
Création et scission de scénarios
Vous pouvez créer rapidement des scénarios à partir de plans connectés existants.
1 Dans la timeline, sélectionnez au moins deux plans connectés.
2 Choisissez Plan > Créer un scénario (ou appuyez sur cmd + G).
Une bordure grise apparaît autour des plans pour indiquer la présence d’un scénario.
La bordure grise 
indique un scénario.
Remarque : Si les plans connectés d’origine ne sont pas contigus, Final Cut Pro insère un plan 
vide pour combler l’espace entre les plans.Chapitre 11 Montage avancé 276
Vous pouvez également créer un scénario en maintenant enfoncée la touche G et en faisant glisser un plan vers un plan connecté jusqu’à ce que leurs bords se touchent :
Maintenez la touche G enfoncée 
lorsque vous faites glisser un 
plan vers un plan connecté.
3 Pour reconvertir un scénario en plans individuels, procédez de l’une des manières suivantes:
• Sélectionnez le scénario (en cliquant sur la bordure grise) et choisissez Plan > Scinder les élé-
ments de plan (ou appuyez sur cmd + Maj + G). 
• Faites glisser le scénario vers le scénario principal.
Sélection et déplacement de scénarios
Vous pouvez sélectionner ou déplacer des scénarios complets comme s’il s’agissait de plans standard ou de plans composés. Ils possèdent les propriétés de connexion des plans connectés.
m Pour sélectionner un scénario complet: cliquez sur la bordure grise du scénario.
m Pour déplacer un scénario en le faisant glisser: cliquez sur la bordure grise du scénario et faites glisser celui-ci vers la gauche ou la droite pour le connecter à un autre point du scénario principal.
Faites glisser horizontalement le scénario.
m Pour déplacer un scénario à l’aide de valeurs de timecode ou de raccourcis clavier: utilisez les mêmes 
techniques que pour les plans standard.
Pour en savoir plus, consultez Disposition des plans dans la timeline à la page 124.Chapitre 11 Montage avancé 277
Ajustement des montages à l’aide de l’éditeur de précision
Vous pouvez ajuster le point de montage entre deux plans dans la timeline à l’aide de l’éditeur 
de précision, qui fournit une présentation étendue des plans de part et d’autre du point de montage ainsi que des parties non utilisées de chaque plan. Vous pouvez modifier (trim ou extension) 
la fin d’un plan et le début de l’autre, séparément ou ensemble. Vous pouvez observer instantanément l’effet de vos modifications sur la coupure ou la transition entre un plan et le suivant.
Un « double » affichage apparaît dans le visualiseur lorsque vous appliquez un trim à des points 
de montage dans la timeline. Pour en savoir plus, consultez Affichage détaillé des commentaires 
sur le trimming à la page 145.
Ajustement du point de montage entre des plans à l’aide de l’éditeur de précision
1 Choisissez l’outil Sélectionner ou l’outil Trim dans le menu local Outils de la barre d’outils, 
puis double-cliquez sur le point de montage auquel vous voulez appliquer un trim dans 
la timeline.
Double-cliquez sur le point de 
montage auquel appliquer un trim.
L’éditeur de précision apparaît avec une présentation étendue des plans sortant et entrant. Le 
point de montage est représenté par une ligne verticale au centre de l’éditeur de précision. Le 
plan sortant et ceux qui le précèdent apparaissent dans la partie supérieure du scénario. Le plan 
entrant et ceux qui le suivent apparaissent dans la partie inférieure.
Les parties estompées des plans à droite et à gauche de la ligne de montage correspondent aux 
données non utilisées disponibles pour le trim (on les appelle les poignées de données). Vous 
pouvez survoler ces zones pour afficher et lire les données afin de déterminer l’endroit où vous 
allez appliquer le trim.
Point d’arrivée du 
plan sortant
Trait de 
montage Skimmer
Poignée du trait de montage Point de départ du plan entrantChapitre 11 Montage avancé 278
2 Pour ajuster le point de montage, effectuez l’une des opérations suivantes:
• Déplacez la ligne de montage au centre de l’éditeur de précision en faisant glisser sa poignée 
vers la gauche ou la droite.
Faites glisser la poignée de ligne 
de montage horizontalement.
Déplacer l’ensemble de la ligne de montage permet d’effectuer un montage Roll.
• Déplacez le point d’arrivée du plan sortant ou le point de départ du plan entrant. Cela permet 
d’effectuer un montage Ripple.
Remarque : Vous pouvez faire glisser la ligne de montage ou les différents points de montage 
tant que des poignées de données sont disponibles. Une fois que vous avez atteint la longueur maximale du plan dans l’une ou l’autre direction, le bord du plan devient rouge.
Déplacez le point d’arrivée 
du plan sortant ou le point de 
départ du plan entrant.Chapitre 11 Montage avancé 279
• Survolez le plan sortant ou entrant et cliquez à l’endroit voulu. 
Cliquez n’importe où sur l’un des deux plans.
Le point de montage du plan est placé au niveau de l’image sur laquelle vous cliquez. Cette 
opération équivaut à un montage Ripple.
Le point de montage du plan se place au 
niveau de l’image sur laquelle vous cliquez.
Vous pouvez également saisir une valeur de timecode pour ajuster numériquement le point 
de montage. Si vous sélectionnez le point d’arrivée du plan sortant ou le point de départ du 
plan entrant, un montage Ripple est effectué. Sinon, un montage Roll est appliqué.
3 Pour atteindre un autre point de montage, effectuez l’une des opérations suivantes:
• Pour atteindre directement un point de montage : cliquez sur l’autre point de montage.
• Pour atteindre le point de montage suivant ou précédent: appuyez sur la touche fléchée vers le 
haut ou vers le bas.
4 Pour fermer l’éditeur de précision, effectuez l’une des opérations suivantes:
• Double-cliquez sur le point de montage actuel, ou appuyez sur la touche Échap.
• Cliquez sur le bouton « Fermer l’éditeur de précision » dans le coin inférieur droit de 
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Création de montages scindés
Final Cut Pro permet de définir des points de départ et d’arrivée distincts pour les données vidéo 
et audio dans un plan donné. Ces montages, appelés montages scindés, peuvent être utilisés 
dans de nombreuses situations, notamment dans des scènes de dialogue, pour le montage d’une 
séquence Roll B à des fins d’illustration dans une interview ou pour effectuer une transition entre 
deux scènes.
 Vous pouvez utiliser un montage scindé pour introduire le son d’un nouveau plan ou d’une 
nouvelle scène avant l’arrivée de ce plan ou de cette scène. À l’inverse, vous pouvez faire appel à 
un montage scindé pour étendre l’audio d’un plan sur le plan suivant. Par exemple, vous pouvez 
passer du plan d’une personne qui parle à la vidéo d’une personne qui écoute tout en conservant l’audio du premier plan.
La technique de montage scindé produit des plans en L et en J, l’audio s’étendant vers la gauche 
ou la droite. C’est ce qu’on appelle des coupes en L et des coupes en J.
Remarque : Lorsque vous utilisez des montages scindés, il est recommandé de sélectionner 
Présentation > Développer les plans audio/vidéo > Pour les scissions (afin qu’une coche apparaisse en regard de l’élément du menu). Ce réglage offre une précision d’affichage optimale pour 
tous vos montages scindés. 
Création d’un montage scindé par glissement
Pour créer un montage scindé, vous devez étendre l’audio d’un plan au plan voisin. Dans cet 
exemple, l’audio du gros plan de l’homme s’étend au gros plan de la femme de sorte à créer une 
coupe en J.
1 Ajoutez des plans à la timeline dans l’ordre dans lequel vous voulez qu’ils apparaissent dans 
votre film.
2 Pour afficher séparément les données audio du plan que vous voulez monter, effectuez l’une des 
opérations suivantes:
• Sur la timeline, sélectionnez le plan dont vous voulez développer l’audio, puis choisissez Plan > 
Développer l’audio/la vidéo (ou appuyez sur ctrl + S).
• Double-cliquez sur la forme d’onde audio du plan.Chapitre 11 Montage avancé 281
Les données audio et vidéo du plan apparaissent sous forme de composants distincts que vous 
pouvez modifier séparément. Ils sont néanmoins toujours connectés et resteront synchronisés. 
3 Faites glisser le point de départ (bord gauche) des données vidéo du plan vers la droite ; cela a 
pour effet d’appliquer au plan un trim de type Ripple. 
L’exemple ci-dessous illustre le glissement du point de départ vidéo du gros plan de l’homme 
vers la droite.
Cela crée un montage scindé en J, le point de départ de l’audio chevauchant le plan précédent.
4 Pour terminer le montage scindé, affichez séparément les données audio du plan précédent, puis 
effectuez l’une des opérations suivantes:
• Faites glisser le point d’arrivée du plan précédent vers la gauche de sorte que les deux plans 
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• Ajustez le niveau audio (fondu) de l’un des deux plans de sorte que le chevauchement des 
plans audio soit naturel. 
5 Si vous souhaitez désactiver l’affichage séparé des données audio pour « remettre en ordre » les 
plans que vous venez de manipuler, effectuez l’une des opérations suivantes:
• choisissez Présentation > Condenser tous les plans.
• Sélectionnez le plan dans la timeline, puis choisissez Plan > Condenser l’audio/la vidéo (ou 
appuyez sur ctrl + S).
• Double-cliquez sur la forme d’onde audio du plan.
Lors de la lecture de cette partie de la timeline, vous pouvez entendre l’homme commencer à 
parler avant l’affichage de son gros plan. Vous pouvez donc utiliser les montages scindés pour 
créer des transitions transparentes entre deux plans consécutifs.
Création d’un montage scindé à l’aide de raccourcis clavier
Vous pouvez créer rapidement des montages scindés à l’aide des raccourcis clavier. Dans cet 
exemple, l’audio du gros plan de l’homme s’étend au gros plan de la femme de sorte à créer une 
coupe en J.
1 Confirmez que les deux plans adjacents disposent de poignées de média suffisantes. Dans le cas 
contraire, réalisez un trim des plans (raccourcir) pour créer les poignées en question.
2 Pour étendre l’audio (afficher l’audio à part) des deux plans adjacents, procédez de l’une des 
manières suivantes:
• Dans la timeline, sélectionnez les plans dont vous voulez étendre l’audio, puis choisissez Plan > 
Développer l’audio/la vidéo (ou appuyez sur ctrl + S).Chapitre 11 Montage avancé 283
• Double-cliquez sur la forme d’onde audio du plan.
3 Placez la tête de lecture sur le point de montage situé entre les deux plans. 
Tête de lecture sur le point de montage
Pour assurer un placement précis de la tête de lecture, faites appel aux raccourcis clavier :
• Pour placer la tête de lecture sur le point de montage précédent: appuyez sur Point-virgule (;) ou 
sur la touche Flèche vers le haut.
• Pour placer la tête de lecture sur le point de montage suivant: appuyez sur Apostrophe (’) ou sur 
la touche Flèche vers le bas.
4 Procédez de l’une des manières suivantes:
• Pour sélectionner les deux bords du point de montage audio : appuyez sur Maj + Barre oblique 
inverse (\).
• Pour sélectionner les deux bords du point de montage vidéo : appuyez sur Barre oblique 
inverse (\).
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5 Procédez de l’une des manières suivantes pour effectuer un montage roll du point de montage 
audio ou vidéo :
• Pour déplacer le point de montage à gauche ou à droite : appuyez sur Virgule (,) ou Point (.) 
respectivement.
• Pour déplacer le point de montage de 10 images vers la gauche ou vers la droite : appuyez respectivement sur Maj +Virgule (,) ou sur Maj + Point (.).
• Pour ajouter ou soustraire du montage actif par le biais du timecode : appuyez sur la touche 
Plus(+) ou Moins(–), saisissez la durée de timecode, puis appuyez sur Retour.
Le champ de saisie du timecode (avec des nombres bleus) apparaît dans le panneau de 
contrôle de la barre d’outils pendant que vous tapez. Pour en savoir plus sur la saisie de 
valeurs de timecode, consultez la section Navigation à l’aide du timecode à la page 151.
Point de montage déplacé Point de montage original
Lors de la lecture de cette partie de la timeline, vous pouvez entendre l’homme commencer à 
parler avant l’affichage de son gros plan. Vous pouvez donc utiliser les montages scindés pour 
créer des transitions transparentes entre deux plans consécutifs.
Réalisation de montages à trois points
Présentation du montage à trois points
Le montage à trois points vous permet d’utiliser des points de départ et d’arrivée définis dans 
le navigateur d’événements et la timeline pour spécifier la durée d’un plan et son emplacement dans la timeline. Le montage à trois points tire son nom du fait que seuls trois points de 
montage sont nécessaires pour définir la partie du plan source à utiliser et l’emplacement de ce 
plan dans la timeline. Final Cut Pro déduit automatiquement le quatrième point de montage. Le 
résultat du montage dépend de la répartition des trois points définis dans le navigateur d’événements et dans la timeline : deux points de départ et un point d’arrivée ou un point de départ et 
deux points d’arrivée.
Vous pouvez utiliser le montage à trois points avec les types de montage suivants: 
• Insérer
• Connecter
• Écraser
Avec chacun de ces types de montage, vous pouvez également effectuer des montages à trois 
points à rebours, dans lesquels le point d’arrivée (et non le point de départ) est aligné sur la position du skimmer ou de la tête de lecture dans le navigateur d’événements ou la timeline. Vous 
pouvez également réaliser des montages à deux points dans lesquels les points de départ et 
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Pour réaliser des montages à trois points, il est important de savoir effectuer des sélections et 
utiliser le skimmer et la tête de lecture. Pour en savoir plus sur les sélections, consultez Sélection 
d’une plage à la page 100 et Sélection d’un ou plusieurs plans à la page 98. Pour en savoir plus 
sur le skimmer et la tête de lecture, consultez Présentation de la lecture et du survol à la page 78.
Le montage à trois points de base se déroule en trois étapes:
Étape 1 : définition des points de montage de la sélection source dans le navigateur 
d’événements
Indiquez quelle partie d’un plan vous souhaitez placer dans la timeline. Pour ce faire, définissez 
les points de départ et d’arrivée. Si vous souhaitez ne définir qu’un point de départ dans le navigateur d’événements, positionnez le skimmer (ou la tête de lecture) à l’endroit où vous voulez 
que le montage commence. Dans ce cas, le point d’arrivée est déterminé d’après les points de 
départ et d’arrivée définis dans la timeline ou d’après la fin du plan. Vous pouvez également 
sélectionner plusieurs plans dans le navigateur d’événements; dans ce cas, la durée totale des 
données source détermine les points de départ et d’arrivée.
Étape 2 : définition de points de montage dans un scénario dans la timeline
Indiquez l’endroit où vous voulez que le plan apparaisse dans la timeline en définissant des 
points de départ et d’arrivée dans le scénario principal ou dans un scénario connecté. Si les 
points de départ et d’arrivée sont tous deux définis dans la timeline, ils déterminent la durée 
du montage, quelle que soit la durée définie dans le navigateur d’événements. Si aucun point 
de départ ou d’arrivée n’est défini dans la timeline, Final Cut Pro utilise la position du skimmer 
comme point de départ du montage. Si le skimmer est absent, Final Cut Pro utilise la position de 
la tête de lecture.
Important : À quelques exceptions près, le montage à trois points nécessite des sélections de 
plage (et non des sélections de plan).
Étape 3 : ajout du plan ou de la sélection source à la timeline
Vous pouvez opter pour un montage par insertion, connexion ou écrasement.
Important : Les points de départ et d’arrivée définis dans la timeline sont toujours prioritaires sur 
ceux définis dans le navigateur d’événements. Cela signifie que si vous définissez des points de 
départ et d’arrivée dans la timeline, ceux-ci déterminent la durée du montage, quels que soient 
les points de départ et d’arrivée définis dans le navigateur d’événements. Cela vous permet de 
limiter votre montage à une section spécifique de la timeline.
Vous devez garder un certain nombre de facteurs à l’esprit lorsque vous réalisez un montage à 
trois points.
Points de montage définis Résultats
• Points de départ et d’arrivée de 
la sélection source définis dans 
le navigateur d’événements
• Point de départ de destination 
défini dans la timeline
Le point de départ de la sélection source dans le navigateur d’événements est aligné sur le point de départ de destination défini dans la timeline, et la durée du montage est déterminée d’après les points de départ 
et d’arrivée de la sélection source dans le navigateur d’événements.
• Point de départ de la sélection 
source défini dans le navigateur 
d’événements
• Points de départ et d’arrivée 
de destination définis dans la 
timeline
Le point de départ de la sélection source dans le navigateur d’événements est aligné sur le point de départ de destination défini dans la timeline, et la durée du montage est déterminée d’après les points de départ 
et d’arrivée de destination définis dans la timeline.
Remarque : Ce montage nécessite la sélection d’une plage dans la timeline. Pour ce faire, vous pouvez utiliser l’outil Sélection de plage ou les 
touches I et O. Pour en savoir plus sur les sélections de plage, consultez 
Sélection d’une plage à la page 100.Chapitre 11 Montage avancé 286
Points de montage définis Résultats
• Points de départ et d’arrivée de 
la sélection source définis dans 
le navigateur d’événements
• Point d’arrivée de destination 
défini dans la timeline
Le point d’arrivée de la sélection source dans le navigateur d’événements 
est aligné sur le point d’arrivée de destination défini dans la timeline, et la 
durée du montage est déterminée d’après les points de départ et d’arrivée de la sélection source dans le navigateur d’événements.
Cette méthode est appelée « backtiming » d’un plan. Vous pouvez y avoir 
recours pour vous assurer qu’un plan se termine à un endroit précis du 
projet. 
• Point d’arrivée de la sélection 
source défini dans le navigateur 
d’événements
• Points de départ et d’arrivée 
de destination définis dans la 
timeline
Le point d’arrivée de la sélection source dans le navigateur d’événements 
est aligné sur le point d’arrivée de destination défini dans la timeline, et la 
durée du montage est déterminée d’après les points de départ et d’arrivée de destination définis dans la timeline.
Cette méthode est appelée « backtiming » d’un plan. Vous pouvez y avoir 
recours pour vous assurer qu’un plan se termine à un endroit précis du 
projet. 
Remarque : Ce montage nécessite la sélection d’une plage dans la timeline. Pour ce faire, vous pouvez utiliser l’outil Sélection de plage ou les 
touches I et O. Pour en savoir plus sur les sélections de plage, consultez 
Sélection d’une plage à la page 100.
Exemples de montage à trois points
Dans Final Cut Pro, vous pouvez réaliser des montages précis en combinant trois (voire deux) 
points de montage définis dans le navigateur d’événements et la timeline. Pour en savoir plus, 
consultez Présentation du montage à trois points à la page 284.
Voici quelques exemples de réalisation de montages à trois points.
Exemple : réalisation d’un montage à trois points
La méthode la plus simple pour réaliser un montage à trois points consiste à définir les points 
de départ et d’arrivée de la sélection source dans le navigateur d’événements, puis à indiquer le 
point de départ de destination dans votre projet en positionnant le skimmer (ou la tête de lecture) dans la timeline.
1 Définissez les points de départ et d’arrivée de la sélection source dans le navigateur 
d’événements.
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2 Dans la timeline, positionnez le skimmer (ou la tête de lecture, si le skimmer est absent) à l’endroit où vous voulez que le plan commence dans votre projet (point de départ de destination). 
Positionnez le skimmer à 
l’emplacement où vous souhaitez que 
le plan commence dans le projet.
3 Pour ajouter la sélection source au projet à l’aide d’un montage par écrasement, appuyez sur la 
toucheD.
Le nouveau plan commence à 
l’emplacement où se trouvait le skimmer.
La partie de votre sélection source située entre les points de départ et d’arrivée apparaît dans la 
timeline ; elle commence au niveau du skimmer.
En ne définissant que trois points, à savoir les points de départ et d’arrivée de la sélection source 
dans le navigateur d’événements et le point de départ de destination dans la timeline, vous avez 
un contrôle total du montage.
Exemple : réalisation d’un montage à trois points à rebours
Vous pouvez réaliser un montage à trois points en définissant les points de départ et d’arrivée 
de la sélection source dans le navigateur d’événements et un point d’arrivée (au lieu d’un point 
de départ) de destination dans la timeline. Cette technique s’appelle le backtiming d’un plan. 
Vous pouvez y avoir recours pour vous assurer qu’un plan donné se termine à un endroit précis 
d’un projet, sur un temps musical. Dans le montage obtenu, le point d’arrivée des données de la 
sélection effectuée dans le navigateur d’événements est aligné sur le point d’arrivée défini dans 
la timeline, et le reste de la sélection source apparaît à gauche.
1 Définissez les points de départ et d’arrivée de la sélection source dans le navigateur 
d’événements.
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2 Dans la timeline, positionnez le skimmer (ou la tête de lecture, si le skimmer est absent) à l’endroit 
où vous voulez que le plan se termine dans votre projet. 
Positionnez le skimmer là où 
le plan doit se terminer.
3 Effectuez l’une des opérations suivantes:
• Pour effectuer un backtiming de la sélection avec un montage par connexion : appuyez sur Maj +Q.
• Pour effectuer un backtiming de la sélection avec un montage par écrasement: appuyez sur Maj +D.
Votre sélection source est montée dans le projet de telle sorte que le point d’arrivée de ses données soit aligné sur le point d’arrivée que vous avez défini dans la timeline.
Le nouveau plan se termine à 
l’emplacement où se trouvait le 
skimmer.
Le reste du plan écrase les données situées à gauche du point d’arrivée sur la durée déterminée 
par les points de départ et d’arrivée de la sélection source définis dans le navigateur d’événements.
Exemple : réalisation d’un montage à trois points avec plusieurs plans
Vous pouvez réaliser des montages à trois points avec plusieurs plans à la fois.
1 Dans le navigateur d’événements, sélectionnez au moins deux plans. (Ne sélectionnez pas une 
plage au sein d’un même plan.)
Pour en savoir plus sur la sélection de plusieurs plans, consultez Sélection d’un ou plusieurs plans à 
la page 98.
Trois plans sont sélectionnés en vue 
d’être placés dans le scénario. Aucune 
sélection de plage n’est définie.Chapitre 11 Montage avancé 289
2 Dans la timeline, définissez un point de départ de destination en positionnant le skimmer à 
l’endroit où vous voulez que le plan ou le groupe de plans commence dans votre projet.
Positionnez le skimmer là 
où le groupe de plans doit 
commencer.
3 Pour ajouter les plans sélectionnés au projet à l’aide d’un montage par écrasement, appuyez sur 
la toucheD.
Le nouveau groupe de plans 
commence depuis le skimmer.
La tête de lecture se place à 
la fin des nouveaux plans.
L’ensemble du groupe de plans sélectionnés dans le navigateur d’événements est monté dans 
le projet.
Remarque : Les plans sont ajoutés dans l’ordre dans lequel vous les avez sélectionnés.
Comme vous avez utilisé un montage par écrasement, tous les éléments de plan déjà présents 
dans le projet sont écrasés par les plans sélectionnés dans le navigateur d’événements sur la 
durée de ces derniers.
Vous pouvez également réaliser un montage à trois points à partir de plusieurs plans dans la 
timeline. Pour sélectionner une plage sur plusieurs plans dans la timeline, utilisez l’outil Sélection 
de plage ou les touches I et O. Pour en savoir plus sur les sélections de plage, consultez 
Sélection d’une plage à la page 100.
Exemple : réalisation d’un montage à deux points
Vous pouvez réaliser un montage sans effectuer aucune sélection dans le navigateur d’événements ou la timeline. C’est ce qu’on appelle un montage à deux points. Dans ce cas, Final Cut Pro 
se base sur le plan actuel dans le navigateur d’événements, de la position du skimmer ou de la 
tête de lecture à la fin du plan, et sur le projet dans la timeline, en avançant à partir de la position 
du skimmer ou de la tête de lecture.
Vous pouvez également réaliser des montages à deux points à rebours, dans lesquels 
Final Cut Pro se base sur le plan actuel dans le navigateur d’événements et sur le projet dans la 
timeline, en reculant à partir de la position du skimmer ou de la tête de lecture. Chapitre 11 Montage avancé 290
Dans les deux cas, la durée du montage est déterminée par la position du skimmer ou de la tête 
de lecture et la fin du plan dans le navigateur d’événements.
1 Pour définir un point de départ pour la sélection source dans le navigateur d’événements, placez 
le skimmer ou la tête de lecture à l’endroit où vous voulez que le montage commence (mais 
n’effectuez aucune sélection).
L’emplacement de la tête 
de lecture du navigateur 
d’événements détermine le point 
d’entrée de la sélection source.
2 Pour définir un point de départ de destination dans la timeline, placez le skimmer ou la tête 
de lecture à l’endroit où vous voulez que le montage commence (mais n’effectuez aucune 
sélection).
L’emplacement du skimmer 
sur la timeline constitue le 
point de départ cible.
3 Pour ajouter le plan au projet à l’aide d’un montage par écrasement, appuyez sur la toucheD.
Le nouveau plan commence au niveau du skimmer.
Le nouveau plan commence 
à l’emplacement où se 
trouvait le skimmer.Chapitre 11 Montage avancé 291
Essai de plans à l’aide des auditions
Présentation des auditions
Dans Final Cut Pro, vous pouvez regrouper des plans connexes dans des ensembles, appelés 
auditions, vous permettant de choisir celui à utiliser. Vous pouvez créer une audition composée 
de différents plans pour tester plusieurs prises ou constituée de plusieurs versions du même 
plan pour effectuer le preview d’effets divers. Dans le navigateur d’événements et la timeline, 
les auditions se présentent sous la forme de plans affichant une icône Audition dans le coin 
supérieur gauche.
Icône d’une audition 
dans le navigateur 
d’événements
Icône d’une audition 
dans la timeline
La pellicule de l’audition affiche le plan actuellement sélectionné, que l’on appelle le meilleur 
élément. Tous les autres plans de l’audition sont appelés plans alternatifs. Vous pouvez ouvrir une 
audition pour afficher le plan sélectionné et les plans alternatifs.
Autres plans
Plan sélectionné
Les auditions vous permettent de conserver vos montages alternatifs sans que cela n’ait d’influence sur les autres plans dans la timeline. Lorsque vous ne visionnez pas les différents plans 
d’une audition, celle-ci se comporte comme un plan individuel. Vous pouvez appliquer un trim 
à une audition, insérer des transitions entre des auditions et d’autres plans, et ajouter des motsclés et des marqueurs. Vous pouvez conserver une audition contenant des plans alternatifs aussi 
longtemps que cela est nécessaire.Chapitre 11 Montage avancé 292
Après avoir passé en revue les plans de l’audition et choisi celui qui convient le mieux à votre 
projet, vous pouvez finaliser l’audition ; elle est alors supprimée et le meilleur élément reste dans 
la timeline sous forme de plan individuel. Celui-ci conserve la position de l’audition dans la timeline ainsi que tous les mots-clés et marqueurs appliqués à l’audition.
Création d’auditions pour essayer des plans
Vous pouvez créer des auditions dans le navigateur d’événements puis les ajouter à la timeline, 
ou les créer directement dans la timeline. Lorsque vous créez des auditions dans la timeline, vous 
pouvez regrouper des plans connexes ou plusieurs versions du même plan (par exemple, pour 
tester plusieurs effets ou plusieurs titres dans le tiers inférieur).
Icône d’une audition 
dans le navigateur 
d’événements
Icône d’une audition 
dans la timeline
Création d’auditions dans le navigateur d’événements
m Sélectionnez les plans à inclure dans l’audition, puis choisissez Plan > Audition > Créer (ou 
appuyez sur cmd +Y).
Création d’auditions dans la timeline
m Pour créer une audition avec des plans connexes: Faites glisser un plan ou un groupe de plans du 
navigateur d’événements vers un plan dans la timeline, puis choisissez une option d’audition 
dans le menu contextuel.
L’option « Ajouter à l’audition » crée une audition dans laquelle le meilleur élément est le plan 
existant dans la timeline. L’option « Remplacer et ajouter à l’audition » utilise le plan que vous 
faites glisser comme meilleur élément.
Important : Si une transition est appliquée au plan existant dans la timeline et que le meilleur 
élément de la nouvelle audition ne dispose pas de suffisamment de données pour cette transition, celle-ci est soit raccourcie, soit supprimée.
m Pour créer une audition avec une copie d’un plan, avec les effets appliqués: Sélectionnez un plan 
dans la timeline, puis choisissez Plan > Audition > Dupliquer comme audition.
L’audition créée contient le plan sélectionné ainsi qu’une copie présentant tous les effets appliqués à l’original.Chapitre 11 Montage avancé 293
m Pour créer une audition avec une copie de la version originale d’un plan, sans les effets appliqués: 
Sélectionnez un plan dans la timeline, puis choisissez Plan > Audition > Dupliquer l’original (ou 
appuyez sur Commande + Maj.+ Y).
L’audition créée contient le plan sélectionné ainsi qu’une copie sans les effets appliqués à 
l’original.
m Pour créer une audition avec une copie de la version originale d’un plan, avec les effets appliqués et les 
attributs à partir d'un autre plan : Sélectionnez un plan dans la timeline qui possède les attribuer 
que vous souhaitez copier et choisissez Édition > Copier (ou appuyez sur Commande + C). Puis, 
sélectionnez le plan que vous souhaitez transformer en audition et choisissez Plan > Audition > 
Dupliquer et coller les effets (ou appuyez sur Commande + Option + Y).
L’audition créée contient le plan sélectionné ainsi qu’une copie présentant les effets et les attributs copiés à partir du premier plan.
Ouverture d’une audition
Après avoir créé une audition, vous pouvez facilement l’ouvrir et examiner son contenu.
Procédez de l’une des manières suivantes:
m Choisissez Plan > Audition > Ouvrir (ou appuyez sur la touche Y).
m Cliquez sur l’icône Audition.
Icône d’audition
La fenêtre Audition s’ouvre ; vous pouvez y prévisualiser vos plans et choisir le meilleur élément.
Ajout et suppression de plans dans les auditions
Lorsque vous créez des auditions pour tester plusieurs plans ou plusieurs versions d’un plan avec 
des effets différents, vous pouvez ajouter et supprimer des plans à tout moment. Dans le navigateur d’événements et la timeline, vous pouvez ajouter et dupliquer des plans dans une audition. 
Dans la timeline, lorsqu’une audition contient les plans que vous voulez tester, vous pouvez l’utiliser pour prévisualiser les plans ou les effets dans votre projet.
Ajout de plans à une audition dans le navigateur d’événements
m Pour ajouter des plans à une audition dans le navigateur d’événements: Sélectionnez l’audition 
et les plans que vous voulez y ajouter, puis choisissez Plan > Audition > Créer (ou appuyez sur 
cmd +Y).
Sélectionnez l’audition.
Sélectionnez les plans 
à ajouter à l’audition.Chapitre 11 Montage avancé 294
m Pour dupliquer un plan au sein d’une audition dans le navigateur d’événements: Cliquez sur l’icône 
affichée dans le coin supérieur gauche de l’audition pour ouvrir la fenêtre Audition, sélectionnez 
le plan à dupliquer, puis cliquez sur Dupliquer.
Sélectionnez le plan à 
copier, puis cliquez sur 
Dupliquer.
Une nouvelle version du plan sélectionné apparaît dans la fenêtre Audition.
Ajout de plans à une audition dans la timeline
m Pour ajouter un plan à une audition en conservant le plan existant dans la timeline comme meilleur 
élément: faites glisser un plan du navigateur d’événements vers l’audition dans la timeline et 
choisissez « Ajouter à l’audition » dans le menu contextuel.
m Pour ajouter un plan à une audition en faisant de celui-ci le meilleur élément: faites glisser un plan 
du navigateur d’événements vers l’audition dans la timeline et choisissez « Remplacer et ajouter 
à l’audition » dans le menu contextuel.
Important : Si une transition est appliquée au plan existant dans la timeline et que le meilleur 
élément de la nouvelle audition ne dispose pas de suffisamment de données pour cette transition, celle-ci est soit raccourcie, soit supprimée.
m Pour dupliquer un plan au sein d’une audition : cliquez sur l’icône Audition affichée dans le coin 
supérieur gauche de l’audition pour ouvrir la fenêtre Audition, sélectionnez le plan à dupliquer, 
puis cliquez sur Dupliquer (ou sur Commande + Maj + Y).
Sélectionnez le plan à 
copier, puis cliquez sur 
Dupliquer.
Une nouvelle version du plan sélectionné apparaît dans la fenêtre Audition.
m Pour ajouter une copie de la version originale d’un meilleur élément d'audition, avec les effets appliqués et les attributs à partir d'un autre plan : Sélectionnez un plan dans la timeline qui possède les 
attribuer que vous souhaitez copier et choisissez Édition > Copier (ou appuyez sur Commande + 
C). Puis, sélectionnez l'audition et choisissez Plan > Audition > Dupliquer et coller les effets (ou 
appuyez sur Commande + Option + Y).
Suppression d’un plan d’une audition
1 Pour ouvrir l’audition contenant le plan que vous voulez supprimer, cliquez sur l’icône affichée 
dans le coin supérieur gauche de l’audition.
2 Dans la fenêtre Audition, sélectionnez le plan à supprimer puis appuyez sur Supprimer.
Le plan est alors supprimé de l’audition. Chapitre 11 Montage avancé 295
Utilisation d’auditions pour essayer des plans dans votre projet
Vous pouvez créer une audition pour tester les plans qu’elle contient et déterminer celui qui 
convient le mieux à votre projet. Bien que le flux de production d’audition soit différent d’un 
projet à un autre, la procédure générale reste la même. Vous créez une audition contenant un 
ensemble de prises, d’effets ou de traitements de texte alternatifs, puis vous choisissez le meilleur plan pour le montage en le sélectionnant comme meilleur élément. Lorsque vous êtes sûr 
de votre choix, vous finalisez l’audition, ce qui a pour effet de la dissoudre en laissant le meilleur 
élément dans la timeline.
Selon votre flux de production, vous pouvez tester les plans de vos auditions et aplatir celles-ci 
au fur et à mesure, ou vous pouvez laisser les auditions dans la timeline pour pouvoir présenter 
des montages alternatifs à un client.
Remarque : Les commandes d’audition ne peuvent être utilisées qu’avec une seule audition 
sélectionnée à la fois. Il est par exemple impossible de finaliser plusieurs auditions sélectionnées.
Passage en revue des plans d’une audition dans la timeline
1 Dans la timeline, sélectionnez l’audition contenant les plans que vous voulez passer en revue, 
puis ouvrez-la en choisissant Plan > Audition > Ouvrir (ou en appuyant sur la toucheY).
Le plan situé sous le projecteur au 
centre de la fenêtre correspond à la 
meilleure image.
2 Dans la fenêtre Audition, sélectionnez le meilleur élément, puis appuyez sur la barre d’espace (ou 
sur les touches cmd + ctrl +Y) pour le lire.Chapitre 11 Montage avancé 296
3 Pour lire un autre plan dans le visualiseur, sélectionnez un plan à droite ou à gauche du meilleur 
élément (ou appuyez sur la touche fléchée vers la droite ou la gauche).
L’autre plan devient la nouvelle 
meilleure image et se lit dans 
le visualiseur.
L’icône représentant l’étoile indique 
la meilleure image précédente.
Conseil : Pour parcourir et lire rapidement des plans alternatifs, sélectionnez une audition fermée 
dans la timeline, appuyez sur la barre d’espace, puis sur ctrl + Flèche gauche pour lire les plans 
situés à gauche de l’élément sélectionné ou sur ctrl + Flèche droite pour lire ceux de droite.
4 Une fois que vous avez trouvé le plan que vous voulez utiliser, assurez-vous qu’il est sélectionné 
sous le spot, puis cliquez sur Terminé.
5 Si vous êtes sûr de votre choix et que vous voulez finaliser l’audition, choisissez Plan > Audition > 
Finaliser l’audition (ou appuyez sur Maj +Option +Y).
L’audition est alors dissoute en laissant le meilleur élément dans la timeline. Le plan sélectionné 
comme meilleur élément conserve les éventuels mots-clés ou marqueurs affectés à l’audition.
Essai de plusieurs effets sur un plan dans la timeline
Vous pouvez tester différents effets sur un plan dans la timeline en créant une audition et en 
ajoutant des effets à des copies de ce plan. Cette technique vous permet de visualiser chaque 
effet dans le contexte des plans précédant et suivant l’audition dans la timeline. 
1 Dans la timeline, sélectionnez le plan sur lequel vous voulez essayer différents effets.
2 Choisissez Plan > Audition > Dupliquer comme audition (ou appuyez sur Option +Y).
3 Recommencez l’étape 2 pour chaque effet que vous voulez tester.
4 Pour ouvrir la fenêtre Audition, cliquez sur l’icône affichée dans le coin supérieur gauche de 
l’audition (ou appuyez sur la touche Y).
5 Pour ouvrir le navigateur d’effets, cliquez sur le bouton Effets dans la barre d’outils (ou appuyez 
sur cmd + 5).
6 Dans la fenêtre Audition, sélectionnez la version du plan à laquelle vous voulez appliquer l’effet.Chapitre 11 Montage avancé 297
7 Dans le navigateur d’effets, sélectionnez l’effet que vous voulez tester et faites-le glisser sur le 
plan dans la fenêtre Audition.
Faites glisser un effet du 
navigateur d’effets sur un plan 
dans la fenêtre Audition.
8 Recommencez les étapes 6 et 7 jusqu’à ce que vous ayez appliqué tous les effets que vous 
voulez tester.
9 Examinez l’impact de chaque effet sur le plan dans la timeline en sélectionnant un plan à droite 
ou à gauche du meilleur élément.
Cliquez sur un autre plan pour 
le lire dans le visualiseur.
Conseil : Pour parcourir et lire rapidement les plans alternatifs, appuyez sur ctrl + Flèche gauche 
pour lire les plans situés à gauche de l’élément sélectionné ou sur ctrl + Flèche droite pour lire 
ceux de droite.
10 Une fois que vous avez choisi l’effet que vous voulez utiliser, sélectionnez le plan avec cet effet 
dans la fenêtre Audition, puis cliquez sur Terminé.
11 Si vous êtes sûr de votre choix et que vous voulez finaliser l’audition, choisissez Plan > Audition > 
Finaliser l’audition (ou appuyez sur Maj +Option +Y).
L’audition est alors dissoute et l’effet choisi est appliqué au plan dans la timeline.Chapitre 11 Montage avancé 298
Conseil : Pour vous permettre de gagner du temps, Final Cut Pro peut dupliquer automatiquement un plan dans la timeline et appliquer un effet à la copie. Pour ce faire, faites glisser un effet 
du navigateur d’effets vers le plan dans la timeline tout en maintenant enfoncée la touche ctrl. 
Vous pouvez également appliquer un effet à chaque plan d’une audition en faisant glisser l’effet 
du navigateur d’effets vers l’audition dans la timeline tout en maintenant enfoncées les touches 
Option et ctrl. Dans les deux cas, vous devez commencer à faire glisser l’effet depuis le navigateur d’effets, puis appuyer sur les touches au moment d’ajouter l’effet au plan.
Resynchronisation de plans pour créer des effets de vitesse
Présentation de la resynchronisation de plans
Vous pouvez ajuster les réglages de vitesse d’un plan pour créer des effets d’accéléré ou de 
ralenti. Vous pouvez également inverser un plan, rembobiner un segment d’un plan, appliquer 
des effets de vitesse variable (également appelés effets de rampe de vélocité) à une sélection 
de plans et créer des ralentis instantanés. Par défaut, Final Cut Pro conserve la tonalité à chaque 
ajustement de la vitesse, mais vous pouvez désactiver cette fonctionnalité pour accentuer l’effet 
de vitesse.
Vous ne pouvez pas appliquer de changements de vitesse à des images fixes, des générateurs, 
des titres et des thèmes dans Final Cut Pro.
Modification de la vitesse du plan
Dans Final Cut Pro, vous pouvez appliquer des changements de vitesse constants ou variables à 
vos plans tout en préservant la tonalité de l’audio. 
Remarque : les réglages de vitesse ne sont appliqués qu’à une occurrence spécifique du plan 
sélectionné. Ils ne sont pas appliqués au fichier multimédia source de ce plan sur le disque. Pour 
créer un fichier multimédia auquel les effets de vitesse sont appliqués, exportez le plan sous 
forme de séquence QuickTime. Pour en savoir plus, consultez Partage de projets, de plans et de 
plages à la page 395.
Changement de vitesse constant
Lorsque vous appliquez un changement de vitesse constant à une sélection de plage ou à un 
plan complet, la vitesse de lecture de l’ensemble de la sélection est modifiée selon le même 
pourcentage. Par exemple, si vous appliquez un réglage de vitesse de 25 pour cent à la sélection, 
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La vitesse constante modifie également la durée d’un plan. Si un changement de vitesse 
constant entraîne une diminution ou une augmentation de la durée d’un plan dans votre 
projet, tous les plans suivants sont décalés vers l’avant ou l’arrière. Si vous choisissez une vitesse 
de 50 pour cent, la durée du plan est doublée. À l’inverse, si vous optez pour une vitesse de 
200 pour cent, le plan est deux fois moins long. Par exemple, si vous réglez la vitesse de lecture d’un plan de 5 secondes sur 50 pour cent, Final Cut Pro ajoute des images au plan pour 
que celui-ci dure 10 secondes et soit lu plus lentement. Si vous réglez la vitesse du plan sur 
200 pour cent, Final Cut Pro supprime des images de sorte que le plan ne dure plus que 
5 secondes et soit lu considérablement plus vite.
Plan identique avec vitesse réglée 
sur 50 pour cent (à présent long de 
10 secondes)
Plan de 5 secondes
1 Dans la timeline, sélectionnez une plage, un plan complet ou un groupe de plans dont vous 
voulez modifier la vitesse.
2 Procédez de l’une des manières suivantes:
• Pour appliquer un réglage de vitesse prédéfini : choisissez Lente ou Rapide dans le menu local 
Resynchronisation de la barre d’outils (illustré ci-dessous), puis sélectionnez une vitesse dans 
le sous-menu.
• Pour appliquer un réglage de vitesse personnalisé : choisissez « Afficher l’éditeur de resynchronisation » dans le menu local Resynchronisation (ou appuyez sur cmd + R) pour afficher l’éditeur 
de resynchronisation au-dessus de la sélection dans la timeline, puis faites glisser la poignée 
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Si vous faites glisser la poignée de resynchronisation vers la droite, la vitesse de la sélection diminue, sa durée augmente et la barre affichée au-dessus d’elle dans la timeline 
devient orange.
Faites glisser la poignée de 
resynchronisation vers la droite 
pour créer un effet de ralenti.
Si vous faites glisser la poignée de resynchronisation vers la gauche, la vitesse de la sélection 
augmente, sa durée diminue et la barre affichée au-dessus d’elle dans la timeline devient bleue.
Faites glisser la poignée de 
resynchronisation vers la gauche 
pour créer un effet d’accéléré.
Changement de vitesse variable
Pour faire varier la vitesse d’un plan dans le temps, en avant ou en arrière, vous pouvez appliquer 
un changement de vitesse variable (également appelé effet de rampe de vélocité). Les changements de vitesse variables créent des effets de lecture sophistiqués grâce auxquels les sujets 
semblent passer aisément d’une vitesse à une autre, avec des transitions nettes ou progressives 
entre chaque changement. Ces types d’effets sont fréquemment utilisés dans les vidéos musicales 
et les spots publicitaires, et ils peuvent être créés directement dans la timeline. Pour appliquer des 
effets de vitesse variable, vous devez diviser un plan en segments de vitesse réglés sur des pourcentages de vitesse précis.
1 Dans la timeline, sélectionnez une plage d’un plan ou un plan complet auquel vous voulez appliquer un effet de rampe de vélocité.
2 Procédez de l’une des manières suivantes:
• Pour réduire progressivement la vitesse : choisissez Rampe de vélocité > jusqu’à 0 % dans le menu 
local Resynchronisation de la barre d’outils.Chapitre 11 Montage avancé 301
• Pour augmenter progressivement la vitesse : choisissez Rampe de vélocité > depuis 0 % dans le 
menu local Resynchronisation de la barre d’outils.
La sélection est divisée en quatre segments ayant chacun un pourcentage de vitesse différent 
pour créer l’effet de rampe. Si une plus grande précision est requise, vous pouvez faire glisser 
manuellement l’une des quatre poignées de resynchronisation pour définir la vitesse voulue.
Faites glisser une poignée de resynchronisation 
pour modifier le pourcentage de vitesse d’un 
segment de rampe de vélocité.
Conserver la tonalité dans les plans resynchronisés
Par défaut, Final Cut Pro conserve la tonalité d’un plan qui a été resynchronisé. Toutefois, si vous 
souhaitez accentuer l’effet de resynchronisation en autorisant les variations de la tonalité en 
fonction de l’ajustement de la vitesse, vous pouvez désactiver cette fonctionnalité.
1 Dans la timeline, sélectionnez une plage, un plan complet ou un groupe de plans dont vous 
voulez modifier la vitesse.
2 Choisissez Conserver la tonalité dans le menu local Resynchronisation de la barre d’outils.
Une coche à gauche du nom de la commande indique que la fonctionnalité Conserver la tonalité 
est activée. Choisissez à nouveau Conserver la tonalité pour la désactiver.
Modification de l’image de fin d’un segment de vitesse
Vous pouvez changer l’image de fin d’un segment de vitesse dans la timeline.
Lorsque vous faites glisser la poignée de resynchronisation d’un segment de vitesse, vous ajustez la vitesse de ce segment, vous n’effectuez pas de trim. La commande « Modifier l’image de 
source de fin » vous permet d’appliquer un trim au point de fin (image de fin) d’un segment.
1 Dans la timeline, sélectionnez un plan contenant des segments de vitesse.
2 Pour afficher l’éditeur de resynchronisation au-dessus du plan dans la timeline, choisissez Éditeur 
de resynchronisation dans le menu local Resynchronisation de la barre d’outils (ou appuyez sur 
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3 Cliquez sur le triangle en regard du pourcentage de vitesse d’un segment de vitesse, puis choisissez « Modifier l’image de source de fin » dans le menu local.
Une icône de pellicule apparaît au-dessus de l’image de fin du segment rapide.
4 Pour changer l’image de fin, faites glisser l’icône de pellicule vers la gauche ou la droite.
Icône 
Pellicule
Pendant le glissement, le visualiseur affiche l’image de fin actuelle.
Adaptation de la vitesse d’un plan à celle du projet
Si vous avez appliqué des effets de vitesse à l’aide de votre caméra, la vitesse d’origine des données source risque de ne pas correspondre à celle des données source des autres plans de votre 
projet dans la timeline. Toutefois, vous pouvez modifier le plan dont la vitesse d’origine diffère 
pour l’adapter aux autres plans présents dans la timeline.
1 Dans la timeline, sélectionnez le plan dont vous voulez modifier la vitesse pour la faire correspondre à celle des autres plans de votre projet.
2 Choisissez Adapter la vitesse dans le menu local Resynchronisation de la barre d’outils.
Lissage d’un plan ralenti à l’aide de préréglages de qualité vidéo
Pour lisser le mouvement apparent d’un plan lu au ralenti, vous pouvez lui appliquer une fusion 
d’images ou une analyse du flux optique.
1 Dans la timeline, sélectionnez une plage, un plan complet ou un groupe de plans dont vous 
voulez modifier la qualité vidéo.
2 Choisissez un réglage Qualité vidéo dans le menu local Resynchronisation de la barre d’outils.
• Normale : réglage par défaut. Les images sont dupliquées et aucune fusion d’images n’est 
appliquée au plan ralenti. Ne nécessite aucun rendu.Chapitre 11 Montage avancé 303
• Fusion d’images: ajoute des images intermédiaires en fusionnant les pixels des images voisines. 
La lecture des plans ralentis créés avec le réglage Fusion d’images semble plus fluide que celle 
des plans créés avec le réglage Normale (duplication). Un rendu est nécessaire.
• Flux optique : ajoute des images intermédiaires à l’aide d’un algorithme de flux optique, qui 
analyse le plan pour déterminer la direction du mouvement des pixels puis dessine partiellement les nouvelles images en fonction des résultats de l’analyse du flux optique. Seule la portion du plan utilisée dans le projet (données situées entre les points de départ et d’arrivée du 
plan) est analysée. Un rendu est nécessaire.
Remarque : Plus il y a d’animation dans un plan, plus l’analyse et le rendu prendront de temps.
Inversion ou rembobinage des plans
Outre la possibilité de modifier la vitesse d’un plan, vous pouvez également ajouter des effets 
directionnels:
• Inverser: inverse l’ordre des images du plan de sorte que la dernière image soit lue en premier.
• Rembobiner: ajoute un segment dupliqué de la sélection de plage ou du plan, rembobine ce 
segment dupliqué à une vitesse de 1x, 2x ou 4x, puis lit le segment de plan d’origine en avant 
et à vitesse normale.
Inversion d’un plan
1 Dans la timeline, sélectionnez un plan complet ou un groupe de plans dont vous voulez inverser 
le contenu.
2 Choisissez Inverser le plan dans le menu local Resynchronisation de la barre d’outils.
La barre verte avec des flèches pointant vers la gauche au-dessus de la sélection dans la timeline 
indique que le plan est inversé.
3 Si vous voulez modifier la vitesse du plan inversé, faites glisser la poignée de resynchronisation 
vers la gauche pour l’augmenter ou vers la droite pour la diminuer.
Segment inversé
Faites glisser 
la poignée de 
resynchronisation 
pour modifier la 
vitesse du plan 
inversé.
4 Pour visualiser l’effet d’inversion, lisez le plan ou la sélection inversé(e).
Rembobinage d’une sélection de plage ou d’un plan
1 Dans la timeline, sélectionnez une plage, un plan complet ou un groupe de plans dont vous 
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2 Choisissez Rembobiner dans le menu local Resynchronisation de la barre d’outils (illustré ci-dessous), puis sélectionnez une vitesse dans le sous-menu.
La sélection est dupliquée, ajoutée à la suite de la sélection d’origine, puis inversée à la vitesse 
choisie. Une autre copie de la sélection de la timeline suit la section inversée et est lue en avant à 
la vitesse d’origine de la sélection.
3 Si vous voulez modifier la vitesse de la section rembobinée ou des sections précédant et suivant 
celle-ci, faites glisser la poignée de resynchronisation de la section vers la gauche pour augmenter la vitesse ou vers la droite pour la diminuer.
Faites glisser une poignée de resynchronisation 
pour modifier la vitesse.
4 Lancez la lecture du plan pour visualiser l’effet de rembobinage.
Création de ralentis instantanés
Vous pouvez appliquer un ralenti instantané à une sélection de plage au sein d’un plan ou à un 
plan complet. Final Cut Pro duplique la plage ou le plan et ajoute les images dupliquées à la suite 
de la sélection sous la forme d’un nouveau segment. Vous pouvez ensuite modifier la vitesse de 
ce nouveau segment pour obtenir l’effet de ralenti instantané recherché.
Création d’un ralenti instantané
1 Dans la timeline, sélectionnez une plage ou un plan complet dont vous voulez utiliser le contenu 
pour créer un ralenti instantané.
2 Choisissez Ralenti instantané dans le menu local Resynchronisation de la barre d’outils.
Une copie de la plage ou du plan est ajoutée à la suite de la sélection et lue en avant à la vitesse 
d’origine de la sélection. (Par défaut, la vitesse de lecture du ralenti instantané est réglée sur 
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3 Si vous voulez modifier la vitesse du segment de ralenti instantané, faites glisser la poignée de 
resynchronisation vers la gauche pour l’augmenter ou vers la droite pour la diminuer.
Plan d’origine 
(désormais un 
segment)
Segment de ralenti 
instantané avec réglage 
de ralenti manuel
Faites glisser la poignée de resynchronisation 
pour modifier la vitesse du segment de ralenti 
instantané.
4 Pour visualiser l’effet de ralenti instantané, lancez la lecture de la sélection d’origine et du segment de ralenti instantané.
Création d’un segment de suspension
Dans Final Cut Pro, vous pouvez suspendre une image donnée pour créer une image fixe, ce 
qui a pour effet d’arrêter temporairement l’action à l’écran. Par défaut, Final Cut Pro ajoute une 
image fixe, appelée segment de suspension, au niveau du skimmer ou de la tête de lecture, mais 
vous pouvez modifier à tout moment la durée de l’image en question.
Une autre solution consiste à créer des plans d’arrêt sur image à part dans Final Cut Pro. Une 
des différences clés entre les images figées et les segments de suspension est que ces derniers 
restent intégrés au plan d’origine et que leur durée peut être ajustée au sein du plan. Pour en 
savoir plus, consultez Création d’images figées à la page 120.
Important : L’ajout d’un segment de suspension à un plan augmente la durée de ce dernier.
Création d’un segment de suspension à image fixe
1 Dans la timeline, effectuez l’une des opérations suivantes:
• Sélectionnez le plan contenant l’image que vous voulez suspendre, puis placez le skimmer ou 
la tête de lecture sur cette image.
• Sélectionnez une plage au sein d’un plan dans la timeline.
2 Choisissez Suspendre dans le menu local Resynchronisation de la barre d’outils (ou appuyez sur 
Maj + H).
Si vous avez sélectionné un plan, un segment de suspension de 2 secondes est ajouté à celui-ci 
au niveau du skimmer ou de la tête de lecture.
Si vous avez sélectionné une plage, un segment de suspension dont la durée correspond à celle 
de la plage est créé. La première image (celle la plus à gauche) de la plage est utilisée comme 
image fixe.Chapitre 11 Montage avancé 306
3 Si vous voulez modifier la durée du segment de suspension, faites glisser la poignée de resynchronisation du segment vers la droite pour l’augmenter ou vers la gauche pour la diminuer.
Faites glisser la poignée de 
resynchronisation pour modifier la 
durée du segment de suspension.
4 Pour visualiser l’effet du segment de suspension, lancez la lecture du plan dans la timeline.
Restauration de la vitesse normale des plans resynchronisés
Vous pouvez restaurer la vitesse de lecture normale (100 pour cent) d’une sélection de plage ou 
d’un plan à tout moment. La restauration de la vitesse supprime en même temps l’ensemble des 
effets directionnels et des suspensions appliqués à la sélection.
Restauration de la vitesse de lecture en avant à 100 pour cent d’une plage ou d’un plan
1 Dans la timeline, sélectionnez une plage, un plan complet ou un groupe de plans dont vous 
voulez restaurer la vitesse d’origine.
2 Choisissez Normale 100 % dans le menu local Resynchronisation de la barre d’outils.
Adaptation des tailles d’images et des fréquences d’images
Final Cut Pro gère automatiquement les réglages du projet. Cela signifie que vous pouvez utiliser 
plusieurs types de média ayant des tailles d’image (ou résolutions) et des fréquences d’images 
différentes dans le même projet. Lorsque vous ajoutez le premier plan vidéo à votre projet, 
Final Cut Pro définit automatiquement le format, la taille d’image et la fréquence d’images de 
l’ensemble du projet en fonction des propriétés de ce premier plan (ou, plus exactement, en 
fonction des propriétés du fichier multimédia source de ce plan). 
Vous pouvez à tout moment modifier les réglages du projet, et vous pouvez contrôler, plan par 
plan, la façon dont Final Cut Pro adapte la fréquence d’images et la taille d’image d’un plan 
pour les faire correspondre aux réglages du projet. Toutes les informations relatives au projet de 
cette section s’appliquent également aux plans composés, qui peuvent posséder leurs propres 
réglages de projet.
Vous pouvez ajouter des plans entrelacés à des projets progressifs (non entrelacés) et des plans 
progressifs à des projets entrelacés. Pour ajouter un plan entrelacé à un projet progressif, suivez 
les instructions ci-dessous. Final Cut Pro accepte automatiquement les plans progressifs dans les 
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Gardez les points suivants à l’esprit lorsque vous travaillez avec plusieurs formats et tailles 
d’image :
• Choisissez les propriétés vidéo et audio de votre projet en fonction de la façon dont vous pré-
voyez de partager votre séquence finale. Par exemple, si vous montez un projet avec un média 
de format mixte et que vous prévoyez de le partager en HD 1080p, définissez ses propriétés 
vidéo sur HD 1080p.
• Si vous ne savez pas encore quel sera le format de distribution final, vous devez au moins 
déterminer la fréquence d’images de votre projet avant de le créer. En effet, le format et la 
taille d’image de votre projet peuvent être modifiés facilement à tout moment, ce qui n’est 
pas le cas de la fréquence d’images, dont la modification peut entraîner le décalage dans le 
temps de tous les points de montage de votre projet.
• Si vous possédez un plan dont les propriétés audio et vidéo correspondent à celles du 
format dans lequel vous prévoyez de partager votre projet, ajoutez-le en premier à ce dernier. Final Cut Pro crée automatiquement les réglages correspondants du projet. Cela vous 
permet de gagner du temps en vous évitant d’avoir à modifier ultérieurement les réglages de 
votre projet.
Conseil : Si le premier plan que vous ajoutez à un projet est un clip audio ou une image fixe, 
Final Cut Pro vous invite à définir les propriétés vidéo de votre projet. Annulez le montage, 
ajoutez un plan vidéo dont le fichier multimédia source présente les propriétés vidéo dont 
vous avez besoin pour votre projet, puis ajoutez le plan non vidéo à ce dernier.
Choix d’une méthode d’adaptation de la taille d’image
Vous pouvez choisir la façon dont Final Cut Pro modifie la taille d’image d’un plan pour la faire 
correspondre aux réglages de taille d’image du projet. Par exemple, Final Cut Pro peut modifier la 
taille d’image du plan de façon à l’ajuster en fonction de la dimension d’image la plus grande du 
projet ou à remplir l’intégralité de l’image du projet (ce qui entraîne généralement un rognage), 
ou il peut laisser la taille d’image du plan telle quelle.
1 Ajoutez à la timeline un plan dont la taille d’image ne correspond pas aux réglages de taille 
d’image (résolution) du projet actuel.
2 Sélectionnez le plan dans la timeline.
3 Pour ouvrir l’inspecteur vidéo, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton Vidéo en haut de la fenêtre qui apparaît.
4 Choisissez une méthode d’adaptation de la taille d’image dans le menu local Type de la section 
Adaptation spatiale de l’inspecteur vidéo.
• Adapter: réglage par défaut. Adapte le plan au réglage de taille d’image du projet sans rogner 
la vidéo du plan. Des barres noires apparaissent sur les côtés des images ne correspondant pas 
à la taille d’image (résolution) du projet. Dans le cas d’un plan de définition standard (SD) dans 
un projet haute définition (HD), Final Cut Pro augmente l’échelle du plan SD pour l’adapter à 
la taille d’image du projet HD. Dans le cas d’un plan HD dans un projet SD, Final Cut Pro réduit 
l’échelle du plan HD pour l’adapter à la taille d’image du projet SD.Chapitre 11 Montage avancé 308
• Remplir: adapte la vidéo du plan de sorte qu’elle occupe la totalité de la taille d’image du 
projet. Dans le cas d’un plan SD dans un projet HD, Final Cut Pro augmente l’échelle du plan 
SD pour l’adapter à la taille d’image du projet HD. La dimension la plus grande du plan est 
rognée pour permettre à la dimension la plus petite de remplir l’écran. Dans le cas d’un 
plan HD dans un projet SD, Final Cut Pro réduit l’échelle du plan HD pour l’adapter à la taille 
d’image du projet SD. La dimension la plus petite du plan est rognée pour permettre à la 
dimension la plus grande de remplir l’écran. 
• Aucune : laisse la taille d’image du plan telle quelle. Si la taille d’image du plan est supérieure à 
celle du projet, le plan est rogné. Si la taille d’image du plan est inférieure à celle du projet, des 
barres noires apparaissent autour du plan.
Choix d’une méthode d’adaptation de la fréquence d’images
Lorsque la fréquence d’images d’un plan diffère de celle du projet, Final Cut Pro utilise une 
méthode d’échantillonnage d’image pour modifier la fréquence d’images du plan afin de la faire 
correspondre à celle du projet. Vous pouvez sélectionner la méthode d’échantillonnage d’image 
utilisée par Final Cut Pro pour modifier la fréquence d’images du plan. La méthode choisie 
dépend de l’importance que vous attachez à l’élimination des à-coups et autres défauts visuels.
1 Ajoutez à la timeline un plan dont la fréquence d’images ne correspond pas aux réglages de fré-
quence d’images du projet actuel.
2 Sélectionnez le plan dans la timeline.
3 Pour ouvrir l’inspecteur vidéo, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton Vidéo en haut de la fenêtre qui apparaît.
4 Choisissez une méthode d’adaptation de la fréquence d’images dans le menu local 
Échantillonnage d’image de la section « Adaptation de la fréquence » de l’inspecteur vidéo.
Remarque : Si le plan sélectionné possède la même fréquence d’images que celle des réglages 
du projet, la section « Adaptation de la fréquence » ne s’affiche pas dans l’inspecteur vidéo.
• Plancher:réglage par défaut. Final Cut Pro tronque à l’entier inférieur le plus proche lors de 
son calcul pour faire correspondre la fréquence d’images du plan à celle du projet.
• Voisin le plus proche :Final Cut Pro arrondit à l’entier le plus proche lors de son calcul pour faire 
correspondre la fréquence d’images du plan à celle du projet. L’option « Voisin le plus proche » 
réduit les défauts aux dépens des à-coups visuels. Un rendu est nécessaire.
• Fusion d’images: crée des images intermédiaires en fusionnant les pixels des images voisines. 
La lecture des plans ralentis créés avec le réglage Fusion d’images semble plus fluide que celle 
des plans créés avec le réglage Plancher ou « Voisin le plus proche ». Ce réglage offre une meilleure réduction des à-coups mais peut engendrer des défauts visuels. Un rendu est nécessaire.
• Flux optique :type de fusion d’images utilisant un algorithme de flux optique pour créer des 
images intermédiaires. Final Cut Pro analyse le plan pour déterminer la direction du mouvement des pixels puis dessine partiellement les nouvelles images en fonction des résultats 
de l’analyse du flux optique. L’option Flux optique offre une meilleure réduction des à-coups 
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Ajouter un plan entrelacé à un projet non entrelacé (progressif)
Certains formats vidéo utilisent une méthode de balayage qui divise une image vidéo en deux 
trames, chacune d’elles étant constituée de lignes paires et impaires alternées, balayées à diffé-
rents moments. 
Si vous souhaitez ajouter un plan entrelacé à un projet progressif, Final Cut Pro peut désentrelacer le plan pour qu’il soit reproduit à pleine résolution et exempt des lignes dentelées associées 
aux plans entrelacés dans les projets progressifs.
1 Procédez de l’une des manières suivantes:
• Dans le navigateur d’événements, sélectionnez les plans entrelacés que vous souhaitez ajouter 
à un projet progressif.
• Dans la timeline, sélectionnez les plans entrelacés que vous avez ajoutés à un projet progressif.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui s’affiche.
3 Dans l’inspecteur d’informations, choisissez la présentation Réglages dans le menu local 
Présentation Métadonnées.
4 Cochez la case Désentrelacer.
Remarque : En sélectionnant le réglage Désentrelacer, la fréquence d’images des plans sélectionnés double. Par exemple, si les plans entrelacés originaux possèdent une fréquence d’images de 
29,97 ips, les plans désentrelacés passent à 59,94 ips. Gardez cela à l’esprit lorsque vous définissez les réglages audio et vidéo de votre projet.
Conseil : Pour confirmer l’absence de défauts liés à l’entrelacement, vous pouvez appuyer 
sur Flèche gauche ou Flèche droite pour naviguer entre les plans dans la timeline, une image 
après l’autre.
5 Choisissez Final Cut Pro > Préférences, cliquez sur Lecture, puis sélectionnez Haute qualité dans 
le menu local Qualité de lecture.
Les plans sont alors reproduits et fonctionnent comme des plans progressifs. Selon la configuration de votre ordinateur, le rendu en arrière-plan peut être nécessaire.
Réglage de métrage anamorphosé
Certains caméscopes et dispositifs d’enregistrement vidéo filment dans les proportions d’écran 
large 16/9 mais enregistrent les données à travers des proportions 4/3. Parfois, les balise de 
métadonnées permettant une lecture en 16/9 du fichier vidéo manquent ou sont incorrectement 
définies. Dans Final Cut Pro, vous pouvez définir cette balise de sorte que la vidéo puisse être lue 
correctement dans des proportions en 16/9 pour écrans larges.
Remarque : Cette option n’est applicable qu’aux (et n’apparaît que pour les) formats en 
définition standard.
1 Dans le navigateur d’événements ou dans la timeline, sélectionnez les plans SD pour lesquels 
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2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui s’affiche.
3 Choisissez la présentation Réglages dans le menu local Présentation Métadonnées situé en bas 
de l’inspecteur d’informations.
4 Dans le menu local Remplacement anamorphosé, choisissez Écran large.
Les plans peuvent dès lors être reproduits et fonctionnent avec les proportions en 16/9 à 
écran large.
Utilisation de rôles pour gérer des plans
Présentation des rôles
Les rôles sont des étiquettes de métadonnées que vous associez à des plans dans le navigateur 
d’événements ou la timeline, afin d’obtenir un moyen souple et performant de gérer votre flux 
de production de montage. Final Cut Pro vous permet d’utiliser des rôles pour organiser vos 
plans dans des événements et des projets, contrôler l’apparence de la timeline ou exporter des 
fichiers vidéo ou audio (également appelés stems) séparément en vue de la distribution, du 
mixage audio ou de la postproduction.
Lorsque vous importez des plans (vidéo, audio ou images fixes), Final Cut Pro analyse les métadonnées de plan existantes pour attribuer l’un des cinq rôles par défaut aux composants vidéo 
et audio de chaque plan : Vidéo, Titres, Dialogue, Musique et Effets. Par exemple, si un fichier de 
média source intègre une balise de métadonnées iTunes « genre », Final Cut Pro attribue le rôle 
Musique au plan obtenu. Final Cut Pro attribue les rôles Vidéo et Dialogue aux plans contenant 
aussi bien de la vidéo et que de l’audio.
Vous pouvez utiliser des rôles pour les flux de production suivants:
• Réaffectation de rôles : vous pouvez visualiser et réaffecter les rôles d’un plan dans l’index 
de la timeline, le navigateur d’événements, l’inspecteur d’informations ou le menu Modifier. 
Consultez Affichage et réattribution de rôles à la page 311. Vous pouvez aussi créer des rôles et 
des sous-rôles personnalisés pour organiser davantage vos plans. 
• Visualiser des plans en fonction du rôle : l’index de la timeline vous permet d’organiser des plans 
en fonction du rôle, d’activer ou de désactiver des rôles et de mettre des plans en surbrillance 
ou de les minimiser en vue de leur affichage dans la timeline. Vous pouvez par exemple identifier facilement tous vos plans de dialogue et les lire isolément par rapport aux autres plans 
audio. Consultez Affichage des plans en fonction du rôle dans la timeline à la page 316.
• Exporter des stems : Il est possible d’exporter des rôles sous forme de stems soit dans un fichier 
QuickTime multipiste combiné, soit dans des fichiers audio ou vidéo séparés. Durant le processus d’exportation, vous pouvez attribuer des sorties mono, stéréo ou Surround à vos canaux 
audio. Consultez Préférences de destinations à la page 441.Chapitre 11 Montage avancé 311
Affichage et réattribution de rôles
Vous pouvez afficher et modifier les rôles attribués aux plans dans l’index de la timeline, le navigateur d’événements, l’inspecteur d’informations ou le menu Modifier.
Tenez compte des éléments suivants lorsque vous utilisez des rôles :
• Chaque plan doit avoir reçu au moins un rôle (les plans à contenu audio et vidéo possèdent 
toujours un rôle audio et un rôle vidéo). Les images fixes reçoivent par défaut le rôle Vidéo, 
mais vous pouvez créer un rôle personnalisé (image fixe) et l’attribuer à vos images fixes.
• Il est impossible d’attribuer des rôles Vidéo à des plans ne contenant que de l’audio ou des 
rôles Audio à des plans ne contenant que de la vidéo.
• Il est possible d’attribuer des rôles aux composants audio ou vidéo d’un plan, mais pas à une 
plage de plans ni à une portion de plan.
• Vous avez également la possibilité d’afficher et de réattribuer le rôle pour un composant audio 
dans l’inspecteur d’informations (ou via le menu Modifier lorsque son plan de ce composant 
se trouve dans la timeline).
• Vous pouvez attribuer des rôles différents à chaque instance d’un plan. Ainsi, les plans que 
vous ajoutez à la timeline depuis le navigateur d’événements ou que vous copiez d’un événement à l’autre ou au sein de la timeline, constituent des instances de plan (des copies) indé-
pendantes les unes des autres.
Affichage et réattribution de rôles dans le navigateur d’événements
1 Dans le navigateur d’événements en présentation par liste, sélectionnez un ou plusieurs plans.
Remarque : Si la colonne Rôles n’est pas visible dans le navigateur d’événements, cliquez sur 
l’en-tête d’une colonne en maintenant la touche ctrl enfoncée et choisissez Rôles dans le 
menu contextuel.
2 Dans la colonne Rôles, cliquez sur le rôle attribué à un plan pour afficher un menu contextuel 
présentant les rôles disponibles.
3 Pour changer l’attribution des rôles dans les plans sélectionnés, choisissez d’autres rôles dans le 
menu contextuel.
Affichage et réattribution de rôles dans l’inspecteur d’informations
1 Sélectionnez un ou plusieurs plans dans le navigateur d’événements ou la timeline.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui s’affiche.Chapitre 11 Montage avancé 312
3 Dans l’inspecteur d’informations, cliquez sur le menu local Rôles pour accéder aux 
rôles disponibles.
4 Pour changer l’attribution des rôles dans les plans sélectionnés, choisissez d’autres rôles dans le 
menu local Rôles.
Affichage et réattribution de rôles dans l’index de la timeline
1 Pour ouvrir l’index de la timeline, cliquez sur le bouton Index de la timeline situé dans le coin 
inférieur gauche de la fenêtre principale de Final Cut Pro (ou appuyez sur Commande + Maj + 2).
2 Pour ouvrir la fenêtre Plans, cliquez sur le bouton Plans en haut de l’index de la timeline. 
3 Si la colonne Rôles n’est pas visible dans la fenêtre Plans, cliquez sur l’en-tête d’une colonne en 
maintenant la touche ctrl enfoncée et choisissez Rôles dans le menu contextuel.
4 Sélectionnez un ou plusieurs plans dans la fenêtre Plans.
5 Pour changer l’attribution des rôles dans les plans sélectionnés, cliquez sur le rôle attribué et 
choisissez d’autres rôles dans le menu contextuel.Chapitre 11 Montage avancé 313
Affichage et réattribution de rôles dans le menu Modifier
1 Sélectionnez un ou plusieurs plans dans le navigateur d’événements ou la timeline.
2 Choisissez Modifier > Attribuer des rôles, puis sélectionnez un rôle dans le sous-menu.
Une coche apparaît en regard du rôle que vous avez choisi.
Affichage et réattribution du rôle d’un composant audio
1 Sélectionnez un plan dans la timeline, puis choisissez Plan > Développer les composants audio 
(ou appuyez sur Option + Contrôle + S).
Composants audio
2 Sélectionnez un composant audio.
3 Pour changer l’attribution du rôle pour le composant sélectionné, procédez de l’une des 
manières suivantes:
• Choisissez Modifier > Attribuer des rôles, puis sélectionnez un rôle dans le sous-menu.
Une coche apparaît en regard du rôle que vous avez choisi.
• Ouvrez l’inspecteur d’informations, puis choisissez un autre rôle dans le menu local Rôles.
Une coche apparaît en regard du rôle que vous avez choisi.
Pour en savoir plus sur les composants audio, consultez À propos des canaux audio et des composants audio à la page 165.
Affichage et réattribution de rôles dans des plans composés
Les plans composés reflètent les rôles des plans d’origine qui les constituent. Vous pouvez afficher et réattribuer les rôles des plans à l’intérieur d’un plan composé, mais vous ne pouvez pas 
attribuer des rôles au plan composé lui-même. 
1 Sélectionnez un plan composé dans le navigateur d’événements ou la timeline.
2 Pour afficher les rôles attribués ou pour attribuer un rôle à chaque plan à l’intérieur du plan composé, procédez de l’une des manières suivantes:
• Colonne Rôles dans le navigateur d’événements en présentation par liste : Suivez les instructions 
présentées dans la section « Affichage et réattribution de rôles dans le navigateur d’événements » ci-dessus.
• Menu local Rôles dans l’inspecteur d’informations : Suivez les instructions présentées dans la section « Affichage et réattribution de rôles dans l’inspecteur d’informations » ci-dessus.
• Colonne Rôles dans la fenêtre Plans de l’index de la timeline : Suivez les instructions présentées 
dans la section « Affichage et réattribution de rôles dans l’index de la timeline » ci-dessus.
• cmd Attribuer des rôles : Suivez les instructions présentées dans la section « Affichage et réattribution de rôles dans le menu Modifier » ci-dessus.Chapitre 11 Montage avancé 314
Lorsque vous attribuez un rôle à un plan composé (le conteneur), le rôle est attribué à tous les plans 
à l’intérieur de ce plan composé. Pour attribuer des rôles différents à certains plans du plan composé, 
vous pouvez ouvrir le plan composé afin de le modifier, puis attribuer individuellement des rôles à des 
plans du plan composé.
Pour en savoir plus sur les plans composés, consultez Présentation des plans composés à la page 266.
Création de sous-rôles et de rôles personnalisés
Vous pouvez créer, outre les cinq rôles par défaut (Vidéo, Titres, Dialogue, Musique et Effets), des sousrôles et des rôles personnalisés.
Important : Soyez prudent lorsque vous créez des sous-rôles et des rôles personnalisés. Les rôles personnalisés (ainsi que leurs noms) ne peuvent pas être modifiés ou supprimés de la liste des rôles. Vous 
pouvez toutefois changer à tout moment les attributions de rôle à des plans.
Création de rôles personnalisés
1 Pour ouvrir l’éditeur de rôle, procédez de l’une des manières suivantes:
• Choisissez Modifier > Modifier les rôles.
• Dans le navigateur d’événements en présentation par liste ou dans la fenêtre Plans de l’index 
de la timeline, cliquez sur un rôle dans la colonne Rôles, puis choisissez Modifier les rôles dans le 
menu contextuel.
• Après avoir sélectionné un plan dans le navigateur d’événements ou dans la timeline, ouvrez l’inspecteur d’informations, puis choisissez Modifier les rôles dans le menu local Rôles.
2 Choisissez le type de rôle dans le menu local Ajouter un rôle situé dans le coin inférieur gauche de 
l’éditeur de rôle.
Le nouveau rôle apparaît en bas de la colonne Rôle.Chapitre 11 Montage avancé 315
3 Saisissez un nom pour le nouveau rôle.
Le nouveau rôle apparaît dans la liste des rôles, afin que vous puissiez l’attribuer à n’importe 
quel plan.
Création de sous-rôles
Les sous-rôles vous permettent d’organiser différents rôles au sein d’un rôle ; vous pouvez par 
exemple créer un sous-rôle Bruitage au sein du rôle Effets ou un rôle Sous-titres espagnols dans 
le rôle Titres.
1 Pour ouvrir l’éditeur de rôle, procédez de l’une des manières suivantes:
• Choisissez Modifier > Modifier les rôles.
• Dans le navigateur d’événements en présentation par liste ou dans la fenêtre Plans de l’index 
de la timeline, cliquez sur un rôle dans la colonne Rôles, puis choisissez Modifier les rôles dans 
le menu contextuel.
• Après avoir sélectionné un plan dans le navigateur d’événements ou dans la timeline, ouvrez 
l’inspecteur d’informations, puis choisissez Modifier les rôles dans le menu local Rôles.Chapitre 11 Montage avancé 316
2 Sélectionnez un rôle dans la colonne Rôle, puis cliquez sur le bouton Ajouter un sous-rôle (signe 
plus) sous la colonne Sous-rôle.
3 Saisissez un nom pour le sous-rôle.
Le nouveau sous-rôle demeure dans la liste Sous-rôle et apparaît en dessous de son rôle parent 
dans les listes de rôles présentes dans Final Cut Pro. Lorsque vous attribuez des sous-rôles à des 
plans dans la timeline, ces sous-rôles apparaissent également dans l’index de la timeline.
Sous-rôles
Affichage des plans en fonction du rôle dans la timeline
Vous pouvez utiliser la fenêtre Rôles de l’index de la timeline pour afficher et lire des plans en 
fonction de leur rôle dans la timeline.
Tous les plans vidéo et audio sont organisés en fonction soit des rôles par défaut (Vidéo, Titres, 
Dialogue, Musique ou Effets), soit de rôles ou de sous-rôles que vous avez créés. Il est possible 
de désactiver certains rôles afin de suspendre la lecture de tous les plans auxquels ces rôles ont 
été attribués. Vous pouvez, par exemple, désactiver tous les rôles sauf le rôle Dialogue pour ne 
lire que les plans de dialogue, puis activer le rôle Musique pour écouter la bande son du film en 
même temps que les dialogues.
Les rôles vous offrent un moyen très efficace d’organiser et de prévisualiser des plans avant de 
les exporter sous forme de fichiers en vue de leur diffusion ou de la postproduction audio.
Remarque : L’activation ou la désactivation des rôles dans l’index de la timeline n’a pas d’effet sur 
les réglages d’exportation ni sur les réglages de plan dans le navigateur d’événements, la timeline ou les inspecteurs.Chapitre 11 Montage avancé 317
Activation ou désactivation des rôles
1 Dans l’index de la timeline, cliquez sur le bouton Rôles.
2 Dans la fenêtre Rôles, cochez les cases en regard des rôles ou des sous-rôles que vous voulez activer. Désélectionnez les cases en regard des rôles ou des sous-rôles que vous voulez désactiver.
Les rôles activés sont affichés en couleur dans la timeline, tandis que les rôles désactivés sont affichés en gris. Si vous désactivez tous les rôles vidéo ou tous les rôles audio, la partie respective des 
plans audio-vidéo est également affichée en gris.
Les plans auxquels un rôle actif est 
assigné apparaissent en couleur.
Les plans auxquels un rôle inactif 
est assigné apparaissent en gris.
Rôles actifs
3 Pour prévisualiser des plans en fonction de leur rôle, effectuez la lecture de votre projet. 
Seuls les plans ayant des rôles activés sont lus.
Mise de rôles en surbrillance dans la timeline
1 Dans l’index de la timeline, cliquez sur le bouton Rôles.Chapitre 11 Montage avancé 318
2 Dans la fenêtre Rôles, cliquez sur le nom du rôle à mettre en surbrillance. 
Les plans ayant reçu ce rôle sont mis en surbrillance dans la timeline. Cela inclut à la fois les plans 
actifs (en couleur) et les plans inactifs (en gris).
Rôle sélectionné Les plans auxquels un rôle sélectionné est 
assigné apparaissent en surbrillance.
Conseil : Pour mettre en surbrillance plusieurs rôles à la fois, sélectionnez-les en maintenant la 
touche Maj enfoncée s’ils sont contigus ou la touche cmd si ce n’est pas le cas.
Réduction des plans en fonction du rôle
Pour dégager de l’espace dans la timeline afin de pouvoir mieux visualiser et manipuler des 
plans, vous pouvez réduire les plans correspondant à certains rôles. Ces plans sont alors affichés 
en plus petit dans la timeline. 
1 Dans l’index de la timeline, cliquez sur le bouton Rôles.
2 Dans la fenêtre Rôles, cliquez sur le bouton de réduction en regard du rôle dont vous souhaitez 
réduire les plans.
Bouton Minimiser Plan minimisé
Les rôles ayant été 
minimisés.
Il est possible également de personnaliser l’affichage des plans dans la timeline en modifiant leur 
apparence et leur hauteur et en déterminant s’ils doivent être visualisés par leur nom ou leur 
rôle. Consultez Ajustement des réglages de la timeline à la page 147. Chapitre 11 Montage avancé 319
Utilisation de rôles pour exporter des stems
Lorsque vous exportez votre travail, vous pouvez utiliser des rôles pour déterminer les détails de 
vos fichiers de sortie. Ce processus est souvent utilisé lorsqu’il s’agit de livrer des fichiers correspondant à certaines spécifications de diffusion ou de remettre des stems en vue du mixage ou 
de la postproduction.
Vous pouvez exporter des rôles dans un fichier QuickTime multipiste combiné ou dans des 
fichiers audio ou vidéo séparés. Durant le processus d’exportation, vous pouvez attribuer des sorties mono, stéréo ou Surround à vos canaux audio.
Pour en savoir plus, consultez Préférences de destinations à la page 441.
Utilisation de fichiers XML pour transférer des projets et des 
événements
Final Cut Pro peut importer ou exporter des fichiers XML (eXtensible Markup Language). Vous 
pouvez utiliser des documents XML (fichiers texte ASCII incluant des éléments balisés) pour 
transférer les détails de vos événements et de vos projets entre Final Cut Pro et des applications 
tierces, des périphériques et des outils de gestion de ressources multimédias incapables de 
reconnaître les événements ou les projets Final Cut Pro.
Les options d’importation et d’exportation XML sont décrites en détail dans la documentation destinée aux développeurs XML Final Cut Pro. Pour en savoir plus, consultez la page consacrée aux applications Apple du site web Apple Developer à l'adresse 
http://developer.apple.com/fr/appleapplications. 
Importation au format XML dans Final Cut Pro
Vous pouvez générer des fichiers XML avec d’autres applications, puis les importer dans 
Final Cut Pro. Lorsque vous importez un fichier XML dans Final Cut Pro, des plans, des événements et des projets sont automatiquement générés dans Final Cut Pro. 
1 Dans Final Cut Pro, choisissez Fichier > Importer > XML.
2 Naviguez ensuite jusqu’au fichier XML à importer, puis cliquez sur Importer.
Final Cut Pro traite le fichier XML et génère des plans, des événements et des projets dans la 
bibliothèque d’événements et la bibliothèque de projets.
Exportation au format XML depuis Final Cut Pro
Vous pouvez exporter des événements et des projets sous forme de fichiers XML.
1 Dans la bibliothèque d’événements ou la bibliothèque de projets, choisissez un ou plusieurs évé-
nements ou projets à exporter sous forme de fichiers XML.
2 Choisissez Fichier > Exporter le fichier XML.
3 Dans la fenêtre qui apparaît, naviguez jusqu’au dossier de votre disque dur où vous voulez enregistrer les fichiers XML, puis cliquez sur Enregistrer.Chapitre 11 Montage avancé 320
Montage de plans multicam
Présentation du montage multicam
Vous pouvez exploiter Final Cut Pro pour monter le métrage de prises multicaméra ou tout 
autre métrage synchronisé en temps réel. Par exemple, si vous filmez un concert en direct ou un 
mariage avec quatre caméras, vous pouvez synchroniser le métrage de chaque angle dans un 
même plan multicam et effectuer des coupes entre les angles en temps réel.
Les différents angles d’un plan multicam sont synchronisés par un point de synchronisation 
commun, une image qu’il vous est possible de reconnaître (visiblement ou à l’oreille) pour 
chacun des angles que vous synchronisez. Lorsque vous ajoutez un plan multicam à la timeline, 
l’angle qui s’affiche dans le visualiseur au moment où vous procédez à la lecture de votre projet 
s’appelle l’angle actif. Alors que les angles actifs se reproduisent dans le visualiseur, vous pouvez 
également visionner tous les angles simultanément dans le visualiseur d’angle, puis effectuer des 
coupes et passer facilement d’un angle à l’autre.
Angle 1
Angle 2 Angle actif
Angle 3
Angle 4
Point de synchronisation
icône Plan multicam
L’utilisation de plans multicam dans Final Cut Pro assure un processus polyvalent et fluide. À tout 
moment, vous pouvez ajouter ou supprimer des angles d’un plan multicam, et adapter facilement la synchronisation entre eux.
Vous pouvez aussi grouper des éléments de métrage non associés pour le montage en temps 
réel (vidéos musicales, par exemple). Par exemple, si vous montez une vidéo musicale, vous 
avez la possibilité d’ajouter plusieurs angles d’images abstraites et d’effectuer des coupes à des 
moments précis de la musique. Il est en outre possible d’exploiter des photos (d’un appareil 
photo) dans un plan multicam. Si les informations de date et heure (Contenu créé) correspondent au contenu des autres angles, les photos sont automatiquement ajustées sur la durée 
de sorte à « remplir » l’angle.
Les plans multicam présentent les caractéristiques suivantes:
• Vous ne pouvez créer de plans multicam que dans le navigateur d’événements, à partir de 
plans d’événements existants. 
• Vous devez effectuer des coupes et adapter les plans multicam dans l’éditeur d’angles, lequel 
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• Lorsque vous ajoutez un plan multicam à la timeline, une relation directe et active s’établit entre le plan multicam « parent » dans le navigateur d’événements et le plan multicam 
« enfant » sur la timeline.
Plans de l’événement
Projet 1 Projet 3
Plan enfant Plans enfants Plan enfant
Projet 2
Plan multicam parent
• Si vous ouvrez un plan multicam dans l’éditeur d’angles (que ce soit depuis le navigateur 
d’événements ou depuis la timeline), il s’agit en fait du plan multicam parent qui s’ouvre 
depuis le navigateur d’événements. Toute modification apportée à un plan multicam dans 
l’éditeur d’angles est transmise à l’intégralité de ses plans enfants, dans tous les projets. Ces 
changements comprennent les réglages de synchronisation ou de trim, la resynchronisation 
de la vitesse des plans, les effets vidéo ou audio tels que l’étalonnage, ainsi que les angles 
ajoutés ou supprimés. Par exemple, si vous supprimez un angle d’un plan multicam parent, il 
est alors supprimé de tous les plans enfants. Pour en savoir plus sur l’éditeur d’angles, consultez la section Synchronisation et ajustement des angles et des plans dans l’éditeur d’angles à 
la page 337.
Flux de production de montage multicam
Le processus à suivre pour la création d’un projet multicam est décrit ci-après. Ces procédures 
sont présentées dans un ordre chronologique approximatif. Vous pouvez par conséquent les 
réorganiser pour répondre aux besoins de votre flux de production.
Tournage d’un événement avec plusieurs caméras et enregistrement des informations de 
synchronisation
Un plan multicaméra utilise plusieurs caméras pour enregistrer le même sujet ou événement 
sous des angles et à des distances différents.
Dans le cas de projets multicam, il peut s’avérer judicieux de régler la date, l’heure et le fuseau 
horaire sur votre caméscope ou tout autre équipement d’enregistrement avant le tournage. Cela 
fournit des informations utiles à Final Cut Pro lors du processus de création automatique des 
plans multicam.
Dans les plans multicaméra professionnels, chaque caméscope ou magnétoscope reçoit le même 
timecode à partir d’un générateur de timecode maître. Vous pouvez aussi effectuer une synchronisation fixe sur le générateur de timecode de chaque caméscope au début du plan. Si vous utilisez un caméscope numérique grand public incompatible avec le timecode externe, vous devez 
enregistrer un signal visuel ou sonore, tel que la fermeture d’un clap ou le flash d’une caméra, sur 
toutes les caméras. Ce signal vous permet de synchroniser les angles dans vos plans multicam.
Dans la mesure où vous pouvez vous servir de la fonctionnalité sophistiquée de synchronisation 
audio automatique de Final Cut Pro pour vous apporter toute la précision nécessaire à la synchronisation multicam, il convient d’enregistrer l’audio sur chaque caméscope et équipement 
d’enregistrement utilisés dans votre production multicam. (À noter que des enregistrements 
audio nets produisent les meilleurs résultats.)Chapitre 11 Montage avancé 322
Importation de média pour un montage multicam
Bien que l’importation de média pour les projets multicam soit identique à celle pour tout autre 
projet, des étapes intermédiaires lors de l’importation sont à même de vous aider à simplifier le 
flux de production multicam.
Attribution du nom des caméras et des angles multicam
Les balises de métadonnées « Nom de la caméra » et « Angle de caméra » vous permettent 
d’automatiser et d’organiser votre flux de production multicam. Il est conseillé (mais cependant 
facultatif) d’appliquer ces balises à vos plans d’événements avant de créer un plan multicam.
Création de plans multicam
Vous devez créer des plans multicam à partir de plans d’événements sélectionnés (comme c’est 
le cas pour les auditions et les plans composés dans le navigateur d’événements). Que vous réalisiez cette étape manuellement ou que Final Cut Pro s’en charge automatiquement, la création 
d’un plan multicam suppose trois étapes essentielles:
• la création d’angles (lesquels contiennent un ou plusieurs plans chacun), 
• la réorganisation de l’ordre des plans dans chaque angle,
• la synchronisation des angles à travers un point de synchronisation commun.
Si vous connaissez le type de métadonnées comprises dans votre média source, vous pouvez 
créer manuellement des plans multicam plus rapidement que par les automatisations proposées. Pour en savoir plus, consultez Attribution du nom des caméras et des angles multicam à la 
page 323 et Création de plans multicam dans le navigateur d’événements à la page 324.
Coupe et passage d’un angle à l’autre dans le visualiseur d’angle
Après avoir créé un plan multicam, il vous est possible de visionner simultanément tous les 
angles dans le visualiseur d’angle tout en passant ou en coupant en temps réel entre les différents angles. Vous pouvez couper et changer les éléments audio et vidéo simultanément ou 
indépendamment. Par exemple, vous pouvez utiliser l’élément audio de l’angle 1 tout en alternant entre les angles 1 à 4 de la vidéo.
Synchronisation et ajustement des angles dans l’éditeur d’angles
Vous pouvez ouvrir à tout moment des plans multicam dans l’éditeur d’angles pour adapter la 
synchronisation et l’ordre des angles ou pour en ajouter ou en supprimer. Vous pouvez aussi 
passer par l’éditeur d’angles pour réaliser des montages dans les différents plans insérés dans un 
plan multicam (par exemple, lors de trim, d’étalonnages, d’ajout de transitions, etc.). 
Montage de plans multicam sur la timeline
Vous pouvez passer directement à des angles multicam sur la timeline ou dans l’inspecteur, sans 
ouvrir le visualiseur d’angle. Bien que les plans multicam présentent des propriétés uniques, 
il vous est possible de les modifier sur la timeline de la même façon que pour le montage 
d’autres plans. 
Importation de média pour un montage multicam
Lorsque vous importez du média dans un projet multicam, vous pouvez attribuer un nom au 
caméscope ou à l’équipement d’enregistrement produisant des fichiers. Final Cut Pro fait appel à 
la balise « Nom de la caméra » pour trier les plans source au sein d’un plan multicam lors du processus de création automatique des plans multicam.
Si vous prévoyez que vos plans multicam compteront de nombreux angles, sélectionnez 
« Utiliser un média proxy » dans les préférences Lecture pour préserver des performances optimales lors de votre montage multicam. Vous pouvez générer les versions proxy nécessaires de 
vos plans lors du processus d’importation. Chapitre 11 Montage avancé 323
Si vous ne possédez que quelques angles dans votre montage multicam, vous avez la possibilité 
de réaliser des versions optimisées de votre média lors de l’importation, par le biais du codec 
Apple ProRes 422. Si vous préférez, il vous est également possible de sélectionner « Créer des 
média optimisés pour des plans multicam » dans les préférences Lecture pour générer automatiquement des données optimisées chaque fois que vous créez un plan multicam. Pour en savoir 
plus, consultez Préférences de lecture à la page 438.
Attribution de nom à une caméra
Les instructions suivantes expliquent comment ajouter la propriété « Nom de la caméra » lorsque 
vous importez des médias à partir d’un dispositif à système de fichiers. Il vous est également 
possible d’ajouter la propriété « Nom de la caméra » a postériori.
1 Branchez votre caméra ou équipement d’enregistrement sur votre ordinateur.
2 Dans Final Cut Pro, choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
3 Dans la fenêtre Importation des médias, sélectionnez votre caméscope ou autre matériel dans la 
liste des dispositifs à gauche, s’il ne l’est pas déjà.
4 Cliquez à nouveau dessus, puis attribuez-lui un nom.
Final Cut Pro affecte ce nom à la propriété de métadonnées « Nom de la caméra » pour tous les 
plans que vous importez depuis l’appareil en question.
Remarque : les caméscopes et équipements d’enregistrement les plus récents (notamment tous 
les dispositifs iOS) enregistrent une balise Identifiant Caméra. Final Cut Pro importe automatiquement les métadonnées Identifiant Caméra lorsque vous importez à partir d’un dispositif à 
système de fichiers et peut exploiter ces informations pour construire automatiquement des 
angles multicam.
Attribution du nom des caméras et des angles multicam
Les propriétés « Nom de la caméra » et « Angle de caméra » constituent des balises de métadonnées polyvalentes qui vous permettent d’organiser votre flux de production multicam. 
Bien qu’il vous soit possible d’attribuer à tout moment des métadonnées à des plans, il s’avère 
plus logique d’affecter les valeurs aux balises « Angle de caméra » et « Nom de la caméra » avant 
d’utiliser les plans pour créer les plans multicam. La balise « Angle de caméra » vous permet de 
déterminer et d’effectuer le suivi des plans apparaissant dans les divers angles. Vous pouvez 
appliquer la balise « Nom de la caméra » lors de l’importation qui peut être utile dans un grand 
nombre de cas, par exemple lors de l’étalonnage des couleurs.
Final Cut Pro vous permet de créer automatiquement ou manuellement des plans multicam. Si 
vous utilisez la méthode de création automatique des angles dans le plan multicam, Final Cut Pro 
recherche les métadonnées dans les plans sélectionnés dans l’ordre suivant : 
• Métadonnées « Angle de caméra »
• Métadonnées « Nom de la caméra »
• Métadonnées « Identifiant Caméra »
Remarque : Les caméscopes et équipements d’enregistrement les plus récents (notamment 
tous les dispositifs iOS) génèrent la balise Identifiant Caméra. Final Cut Pro importe automatiquement les métadonnées Identifiant Caméra lorsque vous effectuez une importation à partir 
d’un dispositif à système de fichiers.
Final Cut Pro exploite les métadonnées « Angle de caméra », « Nom de la caméra » et « Identifiant 
Caméra » pour placer les plans dans le bon angle. Si l’application ne trouve pas ces informations, 
Final Cut Pro crée alors un angle à part pour chacun des plans sélectionnés.Chapitre 11 Montage avancé 324
Attribution du nom des caméras et des angles à des plans sélectionnés
Procédez de l’une des manières suivantes: 
m Sélectionnez des plans dans le navigateur d’événements ou sur la timeline, ouvrez l’inspecteur d’informations, puis saisissez du texte dans le champ « Angle de caméra » ou « Nom de la 
caméra ».
m Dans le navigateur d’événements en présentation par liste, saisissez du texte dans la colonne 
correspondante pour l’un des plans.
Remarque : Si vous utilisez la méthode de création automatique des angles, Final Cut Pro fait 
appel aux balises « Angle de caméra » dans les plans sélectionnés pour nommer les angles dans 
le plan multicam résultant. En l’absence de balise « Angle de caméra », Final Cut Pro s’appuie sur 
les métadonnées « Nom de la caméra », « Nom » (nom du plan) ou « Identifiant Caméra » pour 
attribuer un nom aux angles. Vous pouvez renommer ces angles dans l’éditeur d’angles. Pour 
en savoir plus, consultez Synchronisation et ajustement des angles et des plans dans l’éditeur 
d’angles à la page 337.
Création de plans multicam dans le navigateur d’événements
La création de plans multicam est semblable à la création d’auditions et de plans composés dans 
le navigateur d’événements. Les plans multicam peuvent se composer de diverses sources de 
média (différents formats, fréquences d’images, etc.). Vous pouvez posséder plusieurs plans dans 
un angle donné d’un plan multicam.
Vous pouvez indiquer à Final Cut Pro de créer automatiquement des plans multicam ou 
procéder manuellement.
Si vous connaissez le type de métadonnées comprises dans votre média multicam, vous pouvez 
créer manuellement des plans multicam plus rapidement que par les automatisations proposées. 
Les méthodes automatiques s’appuient sur une technologie sophistiquée de synchronisation 
audio automatique pour assurer la précision de la synchronisation (mais aux dépens du temps 
de traitement). Il est recommandé de désactiver « Utiliser l’audio pour la synchronisation » 
lorsque cette option n’est pas nécessaire. Par exemple, si le timecode exact est enregistré dans 
chaque plan, Final Cut Pro peut créer votre plan multicam automatiquement sans passer par la 
fonctionnalité de synchronisation audio.
Création automatique d’un plan multicam
1 Dans le navigateur d’événements, sélectionnez les plans à inclure dans le plan multicam.
2 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Nouveau plan multicam.
• Cliquez sur la sélection tout en maintenant la touche ctrl enfoncée, puis choisissez Nouveau 
plan multicam dans le menu contextuel.
3 Dans la fenêtre qui s’affiche, attribuez un nom au plan multicam dans le champ Nom.
4 Si les réglages multicam automatiques ne sont pas affichés, cliquez sur « Utiliser les réglages 
automatiques ».
Les réglages multicam automatiques s’affichent.
Remarque : Les réglages automatiques sont affichés par défaut, sauf si le dernier plan multicam 
créé comportait des réglages personnalisés.Chapitre 11 Montage avancé 325
5 Pour synchroniser automatiquement les angles grâce aux données de forme d’onde audio, sélectionnez « Utiliser l’audio pour la synchronisation ». 
Cette option permet des ajustements de synchronisation précis en s’appuyant sur les formes 
d’onde audio de chaque angle. Cette technologie est identique à celle de synchronisation audio 
utilisable pour synchroniser automatiquement les plans en un plan composé. 
Point de synchronisation
Remarque : certains enregistrements audio ne sont pas adaptés à l’usage de cette fonctionnalité. 
Cette option peut entraîner des temps de traitement longs pendant lesquels Final Cut Pro est 
indisponible et bloque ainsi le montage.
6 Cliquez sur OK.
Final Cut Pro crée un plan multicam dans l’événement et place des copies des plans sélectionnés 
dans le nouveau plan multicam.
icône Plan multicam
Création d’un plan multicam à l’aide de réglages personnalisés
1 Dans le navigateur d’événements, sélectionnez les plans à inclure dans le plan multicam.
2 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Nouveau plan multicam.
• Cliquez sur la sélection tout en maintenant la touche ctrl enfoncée, puis choisissez Nouveau 
plan multicam dans le menu contextuel.
3 Dans la fenêtre qui s’affiche, attribuez un nom au plan multicam dans le champ Nom.
4 Si les réglages multicam personnalisés ne sont pas affichés, cliquez sur « Utiliser les réglages 
personnalisés ».
Les réglages personnalisés s’affichent.Chapitre 11 Montage avancé 326
Remarque : Les réglages automatiques sont affichés par défaut, sauf si le dernier plan multicam 
créé comportait des réglages personnalisés.
5 Dans le menu local Assembler les angles, choisissez le mode de création des angles dans le plan 
multicam :
• Automatique : Final Cut Pro crée les angles automatiquement. 
• Angle de caméra : Final Cut Pro crée les angles dans le plan multicam en fonction de la propriété Angle de caméra des plans sélectionnés.
• Nom de la caméra : Final Cut Pro crée les angles dans le plan multicam en fonction de la propriété Nom de caméra des plans sélectionnés.
• Plans: Final Cut Pro crée un angle pour chaque plan sélectionné à l’aide de leur propriété Nom 
afin d’attribuer un nom à l’angle.
6 Dans le menu local « Classement des angles du plan », choisissez le mode de tri des angles dans 
le plan multicam :
• Automatique : Final Cut Pro trie les plans dans chaque angle automatiquement. S’il existe 
plusieurs plans par angle, Final Cut Pro insère plans vides entre les plans, le cas échéant, pour 
obtenir le contrôle du temps et l’espacement adéquats.
• Timecode : Final Cut Pro organise dans chaque angle les plans à l’aide de leur timecode. Si 
vous avez enregistré le timecode dans vos plans, choisissez donc cette option. Elle s’avère plus 
rapide et plus précise en termes d’images pour l’agencement des plans.
• Contenu créé : Final Cut Pro trie les plans dans chaque angle à l’aide des informations de date 
et d’heure enregistrées par votre caméscope ou équipement d’enregistrement vidéo.
La fonctionnalité Contenu créé peut positionner les plans avec une précision d’une seconde 
(sachant que, dans la plupart des caméscopes, l’unité la plus petite inscrite dans les informations de date et d’heure correspond à la seconde). Si vous choisissez cette commande de tri 
des plans, vous aurez probablement besoin de synchroniser manuellement vos angles dans 
l’éditeur d’angles pour que votre plan multicam adopte une précision par image.
Remarque : vous pouvez à tout moment modifier la date et l’heure de la propriété « Contenu 
créé » relative à vos plans source dans le navigateur d’événements. Pour ce faire, sélectionnez simplement des plans, puis choisissez Modifier > Régler la date et l’heure de création 
du contenu.
7 Dans le menu local Synchronisation des angles, choisissez le mode de synchronisation des angles 
dans le plan multicam :
• Automatique : Final Cut Pro synchronise automatiquement les angles (par le biais d’une ou plusieurs des méthodes suivantes). 
• Timecode : Final Cut Pro synchronise les angles en fonction du timecode enregistré dans les 
plans. Pour en savoir plus sur l’enregistrement du timecode, consultez Flux de production de 
montage multicam à la page 321.
01:00:00:00
01:00:00:00 
01:00:00:00
01:00:00:00
Point de synchronisationChapitre 11 Montage avancé 327
• Contenu créé : Final Cut Pro synchronise les angles à l’aide des informations de date et d’heure 
enregistrées par votre caméscope ou équipement d’enregistrement vidéo.
Remarque : vous pouvez à tout moment modifier la date et l’heure de la propriété « Contenu 
créé » relative à vos plans source dans le navigateur d’événements. Pour ce faire, sélectionnez simplement des plans, puis choisissez Modifier > Régler la date et l’heure de création 
du contenu.
12 h 59
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• Début du premier plan : Final Cut Pro utilise la première image de chaque angle comme point 
de synchronisation 
Point de synchronisation
Conseil : la méthode de «Début du premier plan » s’avère utile pour exploiter uniquement 
des sélections sur des plages précises de vos plans source. Dans le navigateur d’événements, 
ajoutez des mots-clés ou le classement Favori à des sélections de plages à utiliser, afin de filtrer 
ou rechercher des plans ultérieurement. Si vous créez votre plan multicam, Final Cut Pro n’utilise que le média affiché dans la présentation filtrée.
• Premier marqueur sur l’angle : Final Cut Pro utilise le premier marqueur de chaque angle 
comme point de synchronisation 
Point de synchronisation
Conseil : cette méthode vous permet d’utiliser le premier marqueur pour définir une région 
pouvant être affinée par le biais de l’option « Utiliser l’audio pour la synchronisation » (décrite 
ci-dessous). En d’autres termes, vous n’avez pas besoin de placer le marqueur avec précision, 
seulement suffisamment près de l’endroit voulu pour que la fonctionnalité de synchronisation 
audio automatique puisse synchroniser les angles suivants.
8 Pour synchroniser automatiquement les angles grâce aux données de forme d’onde audio, sélectionnez « Utiliser l’audio pour la synchronisation ». Chapitre 11 Montage avancé 328
Cette option permet des ajustements de synchronisation précis en s’appuyant sur les formes 
d’onde audio de chaque angle. Cette technologie est identique à celle de synchronisation audio 
utilisable pour synchroniser automatiquement les plans en un plan composé. 
Point de synchronisation
Remarque : certains enregistrements audio ne sont pas adaptés à l’usage de cette fonctionnalité. 
Cette option peut entraîner des temps de traitement longs pendant lesquels Final Cut Pro est 
indisponible et bloque ainsi le montage.
9 Si vous voulez que le timecode du plan multicam commence à une valeur autre que la valeur 
la plus faible dans les plans sélectionnés (ce qui est le comportement par défaut), saisissez une 
valeur de timecode dans le champ Timecode de début.
10 Si vous cherchez à modifier les réglages des propriétés vidéo, sélectionnez Personnalisé dans la 
section Propriétés vidéo, puis adaptez les réglages à vos besoins.
Remarque : Par défaut, Final Cut Pro analyse les plans sélectionnés et configure ces réglages 
d’après les propriétés de plan les plus courantes parmi ces plans.
11 Si vous cherchez à modifier les réglages audio ou de rendu, sélectionnez Personnalisé dans la 
section « Propriétés audio et de rendu », puis adaptez les réglages à vos besoins.
12 Cliquez sur OK.
Final Cut Pro crée un plan multicam dans l’événement et place des copies des plans sélectionnés 
dans le nouveau plan multicam.
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Coupe et passage d’un angle à l’autre dans le visualiseur d’angle
Après avoir créé un plan multicam, il vous est possible de visionner simultanément tous les 
angles dans le visualiseur d’angle tout en passant ou en coupant en temps réel entre les diffé-
rents angles. Cela vous permet de couper un film entier comme s’il était diffusé en direct, puis 
d’apporter des réglages plus fins dans la timeline comme vous le feriez pour toute autre projet.
Le visualiseur d’angle constitue aussi bien un écran qu’une interface interactive pour effectuer 
des choix rapides de coupe et de permutation au fur et à mesure de la reproduction de vos plans 
multicam et de vos projets. Angles apparaissant dans les groupes des angles 2, 4, 9 ou 16.
Visualiseur d’angle
Lecture d’un plan multicam dans le visualiseur d’angle
1 Pour ouvrir le visualiseur d’angle, procédez de l’une des manières suivantes:
• Choisissez Fenêtre > Affichage du visualiseur > Afficher les angles (ou appuyez sur 
Commande + Maj + 7).
• Choisissez « Afficher les angles » dans le menu local des options d’affichage du visualiseur 
situé dans le coin supérieur droit du visualiseur.
Si vous visualisez un plan multicam dans le navigateur d’événements, vous avez l’option d’afficher le visualiseur d’événements en regard du visualiseur. Pour afficher des angles multicam dans 
le visualiseur d’événements, procédez de l’une des manières suivantes:
• Choisissez Fenêtre > Affichage du visualiseur d’événements > Afficher les angles. 
• Choisissez « Afficher les angles » dans le menu local des options d’affichage du visualiseur 
situé dans le coin supérieur droit du visualiseur d’événements.Chapitre 11 Montage avancé 330
2 Utilisez le skimmer ou la tête de lecture pour lire un plan multicam dans le navigateur d’événements ou dans la timeline.
Le visualiseur d’angle apparaît dans le coin supérieur de la fenêtre de Final Cut Pro.
Lire un plan multicam dans le 
navigateur d’événements ou 
dans la timeline.
Les angles du plan 
multicam s’affichent dans 
le visualiseur d’angles.
Angle actif
Coupe et passage d’un angle à l’autre dans le visualiseur d’angle
Vous pouvez couper et passer d’un angle à l’autre « à la volée » (pendant la lecture de votre 
projet) ou survoler des points précis sur la timeline puis couper et basculer entre les éléments. 
Vous pouvez aussi utiliser une combinaison des deux méthodes.
1 Pour ouvrir le visualiseur d’angle, choisissez Fenêtre > Afficher le visualiseur > Afficher les angles 
(ou appuyez sur cmd + Maj + 7).
2 Ajoutez à la timeline le plan multicam à couper et y passer. 
Remarque : la fonctionnalité de coupage et passage ne fonctionne que pour les plans présents 
dans la timeline.
3 Procédez de l’une des manières suivantes:
• Positionnez la tête de lecture et appuyez sur la barre d’espace pour reproduire le 
plan multicam.
• Effectuez le survol de la timeline jusqu’à l’image où vous voulez couper et passer à un 
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4 Dans le visualiseur d’angle, placez le pointeur sur l’angle auquel passer.
Au fur et à mesure que vous déplacez le pointeur sur les angles du visualiseur, le pointeur 
s’adapte en lame de rasoir, ce qui indique qu’une coupe (et un changement d’angle) doit se produire à l’endroit où vous cliquez. 
Le pointeur devient 
un outil de lame.
L’angle actif est en 
surbrillance.
5 Procédez de l’une des manières suivantes:
• Pour couper et passer à un angle : cliquez sur l’angle auquel passer. (Vous pouvez aussi appuyer 
sur la touche d’un chiffre quelconque pour couper et passer à l’angle correspondant du 
groupe actif. Par exemple, appuyez sur 5 pour couper et passer à l’angle 5 du groupe.)
Sur la timeline, le plan multicam actif est alors coupé au niveau de la tête de lecture. La section 
du plan situé à droite de la tête de lecture se voit remplacée par une nouvelle copie du plan, 
avec l’angle sur lequel vous avez cliquez comme angle actif. Une coupe apparaît alors sur la 
timeline au niveau de la tête de lecture. Pour en savoir plus, consultez Montage de plans multicam sur la timeline et l’inspecteur à la page 344. 
• Pour y passer: tout en maintenant la touche Option enfoncée, cliquez sur l’angle auquel passer. 
(Vous pouvez aussi maintenir la touche Option enfoncée et appuyez sur un chiffre pour passer 
à l’angle correspondant du groupe actif. Par exemple, appuyez sur Option + 5 pour passer à 
l’angle 5 du groupe.)
Remarque : le pointeur se change alors en une main lorsque vous maintenez la touche Option 
enfoncée, indiquant une simple opération de passage.
Sur la timeline, le plan multicam au niveau de la tête de lecture change et affiche l’angle 
devenu actif.
Dans un cas ou l’autre, le visualiseur passe à l’angle que vous avez sélectionné. L’angle actif est 
mis en surbrillance jaune, bleu ou vert, selon le mode de passage que vous utilisez. Pour en 
savoir plus, consultez « Permutation indépendante de la vidéo ou de l’audio » ci-après.
Permutation indépendante de la vidéo ou de l’audio
Par défaut dans un plan multicam, Final Cut Pro change d’angle vidéo et audio en même temps. 
Vous pouvez cependant configurer Final Cut Pro pour ne changer que la vidéo ou l’audio 
indépendamment. 
1 Pour ouvrir le visualiseur d’angle, choisissez Fenêtre > Afficher le visualiseur > Afficher les angles 
(ou appuyez sur cmd + Maj + 7).Chapitre 11 Montage avancé 332
2 Pour définir le mode de passage, effectuez l’une des opérations suivantes:
• Activer la permutation audio et vidéo : cliquez sur le bouton de mode de passage de gauche, 
situé dans l’angle supérieur gauche du visualiseur d’angle. Il s’agit du réglage par défaut. 
Cliquez pour autoriser le 
passage de la vidéo à l’audio.
Une surbrillance en jaune 
indique que la vidéo et l’audio 
actifs sont contenus dans un 
seul plan.
Le permutateur d’angles 
affiche l’angle actif.
• Pour activer le passage à la vidéo uniquement: cliquez sur le bouton de mode de passage central. Seule la vidéo change. L’audio de l’angle d’origine reste actif.
Cliquez pour autoriser 
le passage à la vidéo 
uniquement.
• Pour activer le passage à l’audio uniquement: cliquez sur le bouton de mode de passage de 
droite. Seul l’audio change. La vidéo de l’angle d’origine reste active.
Cliquez pour 
autoriser le passage 
à l’audio uniquement.
3 Procédez de l’une des manières suivantes:
• Pour couper et passer à un angle : cliquez sur un angle dans le visualiseur d’angle. 
• Pour y passer: tout en maintenant la touche Option enfoncée, cliquez sur un angle dans le 
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Si vous avez sélectionné le mode de passage limité à la vidéo ou à l’audio uniquement, un cadre 
bleu indique alors l’angle vidéo actif, tandis qu’un cadre vert indique l’angle audio actif.
Bouton Activer 
uniquement la vidéo
Bouton Activer 
uniquement l’audio
L’angle vidéo 
actif est mis en 
surbrillance en bleu.
L’angle audio 
actif est mis en 
surbrillance en vert.
Le permutateur d’angles 
affiche les angles actifs.
Conseil : Après avoir activé la fonction limitée à l’audio, il vous est possible d’ajouter à l’angle 
actif des composants audio à partir d’angles inactifs, ou de supprimer des composants audio de 
l’angle actif. Maintenez simplement appuyées les touches Commande +Option et cliquez sur un 
angle inactif pour ajouter son audio à l’angle actif. Vous pouvez également maintenir appuyées 
les touches Commande +Option et cliquer sur un angle actif pour supprimer son audio. Pour en 
savoir plus, consultez l’exemple « Ajout ou suppression des composants audio d’un plan multicam » dans Exemples de montage audio multicanal à la page 187. 
Visionnage et accès aux groupes d’angles
Selon le réglage d’affichage du visualiseur d’angle choisi, vous pouvez afficher 2, 4, 9 ou 16 angles 
simultanément. Ces ensembles d’angles sont connus sous le nom de groupes. Le sélecteur de 
groupe de Final Cut Pro constitue un outil performant pour l’affichage des groupes d’angles et la 
navigation entre ceux-ci dans un plan multicam.
1 Pour ouvrir le visualiseur d’angle, choisissez Fenêtre > Afficher le visualiseur > Afficher les angles 
(ou appuyez sur cmd + Maj + 7).Chapitre 11 Montage avancé 334
2 Placez le skimmer ou la tête de lecture pour lire un plan multicam dans le navigateur d’événements ou dans la timeline.
Le sélecteur de groupe apparaît alors sous forme de grille en bas du visualiseur d’angle. L’angle 
actif est indiqué en jaune, en bleu ou en vert. 
Le permutateur de groupe 
affiche le nombre d’angles 
et ceux qui sont actifs.
3 Dans le menu local Réglages (dans le coin supérieur droit du visualiseur d’angle), choisissez le 
nombre d’angles à afficher dans chaque groupe.
Menu local Réglages 
dans l’angle supérieur 
droit du visualiser 
d’angles.
Si le nombre d’angles de votre plan multicam dépasse la valeur du réglage d’affichage du visualiseur d’angle, Final Cut Pro crée des groupes supplémentaires et les affiche sous forme de grilles 
distinctes. 
Voici quelques exemples de combinaisons de groupes d’angles: 
• Trois groupes de 4 angles chacun, avec le dernier angle actif situé dans le troisième groupe, ce 
dernier étant affiché :
• Un groupe de 16 angles, avec le dernier angle actif :Chapitre 11 Montage avancé 335
• Un groupe de 9 angles et un autre de 7 angles avec le premier groupe affiché :
4 Pour parcourir les groupes d’angles, procédez de l’une des manières suivantes:
• Pour afficher les angles d’un groupe dans le visualiseur d’angles: cliquez sur le sélecteur de 
groupe pour le groupe.
• Pour afficher le groupe précédent: Appuyez sur les touches Maj +Option + Point-virgule (;).
• Pour afficher le groupe suivant: Appuyez sur les touches Maj +Option + Apostrophe (’).
Incrustations dans le visualiseur d’angle
Pour chaque angle qui figure dans le visualiseur d’angle, vous pouvez afficher les superpositions 
vidéo avec le timecode et soit le nom du plan, soit celui de l’angle.
Nom de l’angle Timecode
1 Pour ouvrir le visualiseur d’angle, choisissez Fenêtre > Afficher le visualiseur > Afficher les angles 
(ou appuyez sur cmd + Maj + 7).
2 Pour choisir une option d’affichage, procédez de l’une des manières suivantes:
• Pour afficher le timecode pour les plans de chaque angle : choisissez Timecode dans le menu 
local Réglages situé dans le coin supérieur droit du visualiseur d’angle. (Choisissez Timecode à 
nouveau pour désactiver l’affichage du timecode.)
Menu local Réglages 
dans l’angle supérieur 
droit du visualiser 
d’angles.
• Pour afficher le nom des plans de chaque angle : dans le menu local Réglages, choisissez 
Pseudonyme > Plan.
• Pour afficher le nom de chaque angle : dans le menu local Réglages, choisissez 
Pseudonyme > Angle.
• Pour désactiver les pseudonymes: dans le menu local Réglages, choisissez 
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Ajustement de l’affichage du visualiseur d’angle
Vous pouvez adapter l’affichage du visualiseur d’angle selon vos besoins.
m Pour régler le nombre d’angles dans le visualiseur d’angle : dans le menu local Réglages situé dans 
le coin supérieur droit du visualiseur d’angle, choisissez 2 angles, 4 angles, 9 angles ou 16 angles.
Visualiseur d’angles 
dans le réglage 
d’affichage 9 angles
Menu local Réglages
m Pour adapter la taille du visualiseur d’angle et du visualiseur principal : faites glisser la séparation 
entre eux.
Faites glisser la limite vers 
la droite.
Faites glisser la limite vers la gauche.Chapitre 11 Montage avancé 337
m Pour organiser le visualiseur d’angle en une colonne : faites glisser la séparation vers la gauche, puis la 
barre d’outils de Final Cut Pro vers le bas pour agrandir verticalement la zone du visualiseur. (Cette 
présentation en colonne n’est disponible que dans les présentations de 2 angles et de 4 angles.)
Faites glisser la limite 
vers la gauche.
Faites glisser la barre 
d’outils vers le bas.
Synchronisation et ajustement des angles et des plans dans l’éditeur d’angles
Vous pouvez ouvrir à tout moment des plans multicam dans l’éditeur d’angles pour adapter la 
synchronisation et l’ordre des angles, pour définir l’angle de contrôle ou pour en ajouter ou en 
supprimer. 
Remarque : si vous ouvrez un plan multicam dans l’éditeur d’angles (que ce soit depuis le navigateur d’événements ou depuis la timeline), il s’agit en fait du plan multicam parent qui s’ouvre. Toute 
modification réalisée dans l’éditeur d’angles est transmise à l’intégralité des plans enfants du plan 
multicam en question pour chaque projet. Pour en savoir plus, consultez Création de plans multicam dans le navigateur d’événements à la page 324. 
L’éditeur d’angles vous permet de monter plusieurs plans en un même plan multicam (un peu 
comme pour un plan composé). Les nombreuses modifications que vous pouvez apporter dans 
l’éditeur d’angles comprennent les montages élémentaires et le trim ainsi que les effets que vous 
devez ajouter habituellement dans la timeline, par exemple les étalonnages et les transitions. 
Vous pouvez copier et coller les plans dans l’Éditeur d’angles. Les plans sont collés de manière 
séquentielle comme montages par écrasement et seulement dans l’angle de contrôle.
Conseil : avant de pouvoir monter des plans multicam dans l’éditeur d’angles, sauvegardez-les 
dans le navigateur d’événements pour conserver des copies de sauvegarde non altérées.
Vous ne pouvez pas couper et passer d’un angle à l’autre depuis l’éditeur d’angles. Vous ne pouvez 
pas non plus connecter de plans, en reproduire en solo, utiliser l’éditeur de précision, effectuer des 
suppressions Ripple ou encore faire appel aux commandes «Détacher l’audio » et « Scinder les élé-
ments de plan ».
Ouverture d’un plan multicam dans l’éditeur d’angles
Procédez de l’une des manières suivantes:
m Double-cliquez sur un plan multicam dans le navigateur d’événements.
m Tout en maintenant la touche ctrl enfoncée, cliquez sur un plan multicam dans le navigateur d’événements ou sur la timeline, puis choisissez «Ouvrir dans l’éditeur d’angles » dans le 
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L’éditeur d’angles s’ouvre sur la zone de la timeline, en bas de la fenêtre de Final Cut Pro. Bien 
que semblable à la timeline, l’éditeur d’angles propose une interface à part dédiée au montage 
des angles et des plans au sein des plans multicam. Chaque angle dans le plan multicam se pré-
sente sur une rangée propre dans l’éditeur d’angles. 
L’éditeur d’angle s’affiche dans 
la zone de la timeline.
Configuration du contrôle vidéo et audio dans l’éditeur d’angles
Dans l’éditeur d’angles, il vous est possible de définir n’importe quel angle comme angle de 
contrôle. Il s’agit de l’angle qui se trouve dans le visualiseur lorsque le plan multicam est lu dans 
l’éditeur d’angles. Vous avez également la possibilité de contrôler l’audio d’un nombre d’angles 
quelconque simultanément.
L’angle de contrôle permet de synchroniser ceux repris dans l’éditeur d’angles. Il n’est cependant 
pas identique à l’angle actif (celui affiché dans la timeline). Vous ne pouvez pas couper et passer 
d’un angle à l’autre depuis l’éditeur d’angles.
Remarque : le réglage du bon angle de contrôle s’avère important pour les deux commandes de 
synchronisation décrites plus loin dans cette section : « Synchroniser avec l’angle de contrôle » et 
« Synchronisation de l’angle avec l’angle de contrôle à l’aide de l’audio ».
1 Pour ouvrir l’éditeur d’angles, procédez de l’une des manières suivantes:
• Double-cliquez sur un plan multicam dans le navigateur d’événements.
• Tout en maintenant la touche enfoncée, cliquez sur un plan multicam dans le navigateur 
d’événements ou sur la timeline, puis choisissez «Ouvrir dans l’éditeur d’angles » dans le 
menu contextuel.
2 Pour définir un angle comme angle de contrôle, effectuez l’une des opérations suivantes:
• Cliquez sur l’icône Contrôle vidéo, qui se trouve à gauche de l’angle.
• Choisissez «Définir l’angle de contrôle » à partir du menu local en regard du nom de l’angle.
• Appuyez sur Maj +V lors du survol de l’angle.Chapitre 11 Montage avancé 339
L’icône Contrôle vidéo devient alors blanche et l’angle tout entier se voit encadré en gris 
clair. L’angle se lit dans le visualiseur lorsque vous reproduisez le plan multicam dans l’éditeur 
d’angles. Vous ne pouvez définir qu’un seul angle vidéo de contrôle à la fois.
Cliquez pour définir l’angle de contrôle.
3 Pour activer le contrôle audio pour un angle, procédez de l’une des manières suivantes:
• Cliquez une fois sur l’icône Contrôle audio. (Pour désactiver le contrôle audio, cliquez à nouveau dessus.)
• Choisissez Contrôler l’audio à partir du menu local en regard du nom de l’angle. (Pour désactiver le contrôle audio, choisissez à nouveau Contrôler l’audio.)
• Appuyez sur Maj + A lors du survol de l’angle. (Pour désactiver le contrôle audio, appuyez à 
nouveau sur Maj + A.)
Contrôle audio activé
Contrôle audio désactivé
Les réglages du contrôle n’influent sur aucun angle actif. Ils modifient simplement ce qui est 
reproduit dans le visualiseur lorsque vous travaillez dans l’éditeur d’angles.Chapitre 11 Montage avancé 340
Conseil : vous pouvez faire appel au contrôle audio pour vérifier la synchronisation des différents 
angles dans un plan multicam. Ouvrez le plan dans l’éditeur d’angles, puis activez le contrôle 
audio pour plusieurs angles. Vous pouvez dès lors entendre si les angles sont synchronisés ou si 
vous devez les ajuster davantage. 
Réglage manuel de la synchronisation d’un plan multicam
Une fonction principale de l’éditeur d’angles est d’assurer un moyen simple de corriger les 
angles désynchronisés de vos plans multicam. Les instructions ci-dessous décrivent comment 
synchroniser les angles en localisant les points de synchronisation puis en les faisant glisser 
manuellement pour les aligner.
1 Pour ouvrir l’éditeur d’angles, procédez de l’une des manières suivantes:
• Double-cliquez sur un plan multicam dans le navigateur d’événements.
• Tout en maintenant la touche ctrl enfoncée, cliquez sur un plan multicam dans le navigateur 
d’événements ou sur la timeline, puis choisissez «Ouvrir dans l’éditeur d’angles » dans le 
menu contextuel.
2 Accédez à un point de synchronisation dans l’un des angles désynchronisés en effectuant le 
survol de l’angle dans l’éditeur d’angles.
Au fur et à mesure du survol, l’angle s’affiche dans le côté gauche du visualiseur (au lieu du visualiseur d’angle). Les points de synchronisation peuvent correspondre à des signaux vidéo ou audio 
(tels qu’un clap de fin ou le claquement d’une porte).
3 Retrouvez le point de synchronisation correspondant dans les angles à synchroniser sur l’angle 
d’origine.
Pour simplifier ce processus, vous pouvez ajouter des marqueurs aux points de synchronisation 
pour vous guider sur le plan visuel et indiquer des points d’alignement.
4 Faites glisser les plans horizontalement sur les rangées de l’éditeur d’angles pour aligner verticalement les points de synchronisation.
Point de synchronisation
Point de synchronisation
Faites glisser le plan 
pour aligner les points 
de synchronisation.Chapitre 11 Montage avancé 341
Si un angle contient plusieurs plans, vous pouvez facilement sélectionner tous les plans de 
l’angle afin de les déplacer tous à la fois. Pour ce faire, choisissez « Sélectionner les plans dans 
l’angle » à partir du menu local en regard du nom de l’angle.
Pour sélectionner tous les plans dans 
un angle, choisissez « Sélectionnez 
les plans dans l’angle »
Vous pouvez faire glisser les plans horizontalement pour les déplacer ensemble.
Lorsque tous les plans de l’angle 
sont sélectionnés, vous pouvez 
tous les faire glisser ensemble.
Réglage automatique de la synchronisation d’un plan multicam
Les instructions ci-dessous décrivent deux méthodes automatiques de synchronisation des 
angles dans un plan multicam.
1 Pour ouvrir l’éditeur d’angles, procédez de l’une des manières suivantes:
• Double-cliquez sur un plan multicam dans le navigateur d’événements.
• Tout en maintenant la touche ctrl enfoncée, cliquez sur un plan multicam dans le navigateur 
d’événements ou sur la timeline, puis choisissez «Ouvrir dans l’éditeur d’angles » dans le 
menu contextuel.
2 Dans l’angle désynchronisé, cliquez sur le menu local situé à droite du nom de l’angle, puis choisissez l’une des options suivantes: 
• Synchroniser avec l’angle de contrôle : cette option entraîne l’ouverture d’un double affichage 
dans le visualiseur, reprenant l’image au niveau du skimmer à gauche et celle au niveau de 
la tête de lecture de l’angle de contrôle à droite. Dans l’angle désynchronisé, effectuez un 
survol jusqu’à une image, puis cliquez pour synchroniser l’angle au niveau de la tête de lecture. Tous les plans dans l’angle se déplacent ensemble pour aligner l’image sur laquelle vous 
avez cliquée avec la tête de lecture. Pour fermer le double affichage du visualiseur, cliquez 
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• Synchroniser l’angle avec l’angle de contrôle : cette option compare les formes d’onde audio 
dans l’angle sélectionné aux formes d’onde dans l’angle de contrôle, puis déplace les plans 
dans l’angle sélectionné pour les synchroniser avec celles de l’angle de contrôle. Cette technologie est identique à celle de synchronisation audio utilisable pour analyser et synchroniser 
automatiquement les plans en un plan composé. 
Si vous sélectionnez des plans dans un ou plusieurs angles avant de choisir cette option, le 
nom de la commande dans le menu local devient « Synchroniser la sélection avec l’angle de 
contrôle ». Lorsque vous choisissez cette option, Final Cut Pro déplace tous les plans sélectionnés pour les synchroniser avec ceux de l’angle de contrôle. S’il existe une sélection dans 
l’angle de contrôle, cette option n’est pas disponible.
AVERTISSEMENT : Cette option n’effectue pas de Ripple des plans vers l’avant. Si les plans sont 
déplacés vers un emplacement de la timeline déjà occupé par des plans, les plans déplacés 
écrasent les anciens.
Remarque : certains enregistrements audio ne sont pas adaptés à l’usage de cette fonctionnalité. Cette option peut entraîner des temps de traitement longs pendant lesquels Final Cut Pro 
est indisponible et bloque ainsi le montage.
Tri des angles dans un plan multicam
Vous pouvez modifier l’ordre dans lequel les angles apparaissent dans le visualiseur d’angle et 
l’éditeur d’angles.
Remarque : Si vous avez déjà commencé un montage multicam sur un plan multicam dans la 
timeline, changer l’ordre des angles n’influe en rien sur l’angle choisi pour chaque montage et 
effectuer des coupes et des passages.
1 Pour ouvrir l’éditeur d’angles, procédez de l’une des manières suivantes:
• Double-cliquez sur un plan multicam dans le navigateur d’événements.
• Tout en maintenant la touche ctrl enfoncée, cliquez sur un plan multicam dans le navigateur 
d’événements ou sur la timeline, puis choisissez «Ouvrir dans l’éditeur d’angles » dans le 
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2 À droite de l’éditeur d’angles, faites glisser les rangées d’angles verticalement à l’aide des poignées de glissement pour les réorganiser.
Utilisez les poignées 
pour réorganiser les 
angles.
Les angles présents dans l’éditeur et le visualiseur adoptent le nouveau tri.
Ajout, suppression ou renommage d’angles dans un plan multicam
1 Pour ouvrir l’éditeur d’angles, procédez de l’une des manières suivantes:
• Double-cliquez sur un plan multicam dans le navigateur d’événements.
• Tout en maintenant la touche ctrl enfoncée, cliquez sur un plan multicam dans le navigateur 
d’événements ou sur la timeline, puis choisissez «Ouvrir dans l’éditeur d’angles » dans le 
menu contextuel.
2 Procédez de l’une des façons suivantes:
• Pour supprimer un angle : choisissez Supprimer l’angle dans le menu local situé à droite du 
nom de l’angle.
L’angle est alors supprimé de l’éditeur d’angles, du visualiseur d’angle et de tous les plans 
enfants du plan multicam.
Important : la suppression d’un angle actif influe sur les montages de votre projet. L’angle 
supprimé est remplacé par un vide noir dans tous les projets.
• Pour ajouter un angle : choisissez Ajouter un angle dans le menu local situé à droite du nom 
de l’angle.
Un nouvel angle vide apparaît dans l’éditeur d’angles et dans le visualiseur d’angle.
• Pour renommer un angle : sur la partie de gauche de l’éditeur d’angles, cliquez sur le nom de 
l’angle à renommer. Lorsque le texte apparaît en surbrillance, attribuez le nouveau nom.
Ce dernier s’affiche dans l’éditeur d’angles et, si les superpositions sont activées, dans le visualiseur d’angle.Chapitre 11 Montage avancé 344
Montage de plans multicam sur la timeline et l’inspecteur
Vous pouvez passer directement à des angles de plan multicam sur la timeline ou dans l’inspecteur d’informations, sans ouvrir le visualiseur d’angle.
Les plans multicam fonctionnent en règle générale dans la timeline comme tout autre plan standard. Vous pouvez ajouter des effets vidéo et audio, des transitions et des marqueurs, attacher 
des plans connectés et appliquer des effets de resynchronisation. Vous pouvez appliquer des 
montages scindés aux plans multicam et les monter dans l’éditeur de précision. Vous avez la possibilité d’imbriquer des plans multicam en plans composés et dans des scénarios.
Les plans multicam présentent cependant des caractéristiques uniques dans la timeline :
• Vous pouvez afficher le nom des angles vidéo et audio actifs dans le plan multicam repris sur 
la timeline.
• Les points de montage de coupe et de passage apparaissent sous forme de lignes en pointillé 
sur la timeline. Il s’agit de coupes (dans lesquelles le contenu vidéo ou audio d’un côté ou d’un 
autre du point de montage est continu). Dans un montage multicam, les coupes indiquent 
que le contenu d’un côté ou de l’autre du point de montage provient du même plan multicam. Une ligne en pointillé noire indique que différents angles du même plan multicam se 
trouvent d’un côté ou d’un autre du point de montage. 
Avant la coupe, l’angle est 
« voiture à gauche »
Point de montage 
standard
Après la coupe, l’angle est 
« voiture à droite »
Un point de montage de transit 
s’affiche à l’emplacement de la 
tête de lecture.Chapitre 11 Montage avancé 345
Dans le cas de coupes et passages de vidéo seule ou d’audio seul, le point de montage peut 
être mixte (lignes noire et blanche en pointillé). Par exemple, si vous effectuez une coupe et 
un passage de vidéo seule, une ligne en pointillé noire apparaît pour la vidéo et une blanche 
s’affiche pour l’audio. 
Les lignes noires en pointillé indiquent que les 
angles de par et d’autre du point de montage sont 
différents mais proviennent du même plan multicam.
Une ligne blanche en pointillé indique 
que l’angle est le même de par et 
d’autre du point de montage.
• Lorsque vous placez le pointeur sur une coupe multicam, le pointeur se transforme en outil 
Trim, indiquant que la coupe sera un montage roll (car tout autre type de montage rompt la 
relation entre les plans de chaque côté du point de montage de coupe et de passage sur la 
timeline).
• De nombreux montages (tels que les montages scindés, les marqueurs, les plans connectés et 
les effets de resynchronisation) conservent leur place dans un plan multicam sur la timeline, 
même après un changement d’angle. Certaines opérations de montage sont cependant associées directement à l’angle actif et ne sont pas conservées si vous le modifier. Il s’agit : 
• des effets vidéo et audio,
• des animations avec des images clés (avec volume et balance),
• des attributions de rôles.
Passage d’angles sur la timeline 
1 Sur la timeline, tout en maintenant la touche ctrl enfoncée, cliquez sur le plan multicam sur 
lequel passer.
2 Procédez de l’une des manières suivantes:
• Pour changer d’angle vidéo : choisissez « Activer l’angle vidéo » dans le menu contextuel, puis 
dans le sous-menu l’angle auquel vous voulez passer.
• Pour changer d’angle audio : choisissez « Activer l’angle audio » dans le menu contextuel, puis 
dans le sous-menu l’angle auquel vous voulez passer.
Le plan passe donc à l’angle vidéo ou audio sélectionné.Chapitre 11 Montage avancé 346
Passage d’angles dans l’inspecteur
Le changement d’angles dans l’inspecteur vous permet de passer d’un angle à l’autre pour plusieurs plans multicam sélectionnés simultanément.
1 Sélectionnez le ou les plans multicam pour lesquels changer l’angle.
2 Ouvrir l’inspecteur d’informations.
3 Dans l’inspecteur d’informations, procédez de l’une des manières suivantes:
• Pour changer d’angle vidéo : dans le menu local « Activer l’angle vidéo », choisissez l’angle 
auquel passer.
• Pour changer d’angle audio : dans le menu local « Activer l’angle audio », choisissez l’angle 
auquel passer.
 Affichage du nom des angles vidéo et audio actifs sur la timeline
Vous pouvez indiquer à Final Cut Pro d’afficher le nom des angles vidéo et audio actifs dans 
le plan multicam sur la timeline au format suivant : V : nom de l’angle vidéo | A : nom de 
l’angle audio.
Angle vidéo actif
Angle audio actif
m cliquez sur le bouton Apparence du plan situé dans le coin inférieur droit de la timeline, puis 
choisissez « Noms ou angles du plan » dans le menu local Afficher.
Conseils et astuces applicables aux montages multicam
Les conseils suivants contribuent à optimiser votre flux de production multicam :
• Réglez la date, l’heure et le fuseau horaire sur votre caméscope ou équipement d’enregistrement avant le tournage destiné à votre projet multicam. Cela fournit des informations utiles à 
Final Cut Pro lors du processus de création automatique des plans multicam.
Remarque : vous pouvez à tout moment modifier la date et l’heure de la propriété « Contenu 
créé » relative à vos plans source dans le navigateur d’événements. Pour ce faire, sélectionnez simplement des plans, puis choisissez Modifier > Régler la date et l’heure de création 
du contenu.
• Dans la mesure où vous pouvez vous servir de la fonctionnalité sophistiquée de synchronisation audio automatique de Final Cut Pro pour vous apporter toute la précision nécessaire à la 
synchronisation multicam, il convient d’enregistrer l’audio sur chaque caméscope et équipement d’enregistrement utilisés dans votre production multicam. (À noter que des enregistrements audio nets produisent les meilleurs résultats.)
• Avant de pouvoir monter des plans multicam dans l’éditeur d’angles, sauvegardez-les dans le 
navigateur d’événements pour conserver des copies de sauvegarde non altérées.
• Pour vérifier la synchronisation d’angles précis dans un plan multicam, ouvrez le plan dans 
l’éditeur d’angles, puis activez le contrôle audio pour plusieurs angles. Vous pouvez dès lors 
entendre si les angles sont synchronisés ou si vous devez les ajuster davantage.Chapitre 11 Montage avancé 347
• Si les performances s’amenuisent grandement lorsque vous travaillez sur un projet multicam, 
effectuez l’une des opérations suivantes: 
• Indiquez à Final Cut Pro de procéder à la lecture proxy en sélectionnant l’option « Utiliser 
un média proxy » dans les Préférences Lecture. La lecture proxy vous permet de reproduire 
simultanément un nombre plus important d’angles. Pour utiliser la lecture proxy, vous devez 
posséder des versions proxy de votre média ou en créer. Pour en savoir plus sur la création 
de versions proxy, consultez la section Transcodage des fichiers de média à la page 415.
• Assurez-vous que l’option « Créer des médias optimisés pour des plan multicam » est sélectionnée dans les préférences Lecture. Pour en savoir plus, consultez Préférences de lecture à 
la page 438. Cette option transcode la vidéo au format du codec Apple ProRes 422, ce qui 
assure de meilleures performances lors du montage multicam. Cette option est activée par 
défaut. Si le format original de la caméra peut être monté en offrant de bons résultats, vous 
pouvez alors décocher cette case.
• Assurez-vous que le disque dur hébergeant vos plans source multicam est suffisamment 
rapide pour reproduire l’intégralité de votre média en une seule fois. Il vous est possible de 
vérifier les performances du disque dur en choisissant Final Cut Pro > Préférences, puis en 
sélectionnant « Avertir lors de l’omission d’images à cause d’une mauvaise performance du 
disque dur ». Pour savoir si quelque chose d’autre provoque des problèmes de lecture, sélectionnez « Avertir lors de l’omission d’images durant la lecture ». 
• Vous pouvez exploiter des photos (tirées d’un appareil photo) dans un plan multicam. Si les 
informations de date et heure (Contenu créé) correspondent au contenu des autres angles, les 
photos sont automatiquement ajustées sur la durée de sorte à « remplir » l’angle.12
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Incrustation
Présentation de l’incrustation
Il arrive que vous deviez combiner deux plans pour créer une image comportant des parties de 
chacun d’eux. Une méthode courante pour combiner deux plans consiste à utiliser un traitement 
d’incrustation, dans lequel la vidéo du plan supérieur (premier plan) est traitée pour éliminer une 
couleur ou une valeur de luminance donnée dans certaines zones, puis combinée à celle du plan 
inférieur (arrière-plan).
L’incrustation vous permet, par exemple, de prendre un plan vidéo d’une personne se tenant 
devant un fond vert et de remplacer ce dernier par une scène de rue pour donner l’impression 
que la personne se trouve dans la rue.
Ce type d’incrustation s’obtient à l’aide de l’un des deux effets d’incrustateur disponibles dans 
Final Cut Pro :
• Incrustateur: cet effet d’incrustation chromatique général est optimisé pour l’incrustation sur 
fond vert ou bleu mais peut être utilisé avec n’importe quelle couleur. Consultez Utilisation des 
incrustations chromatiques à la page 348.
• Incrustateur en luminance : cet effet est conçu pour générer des caches basés sur la luminosité 
de l’image : vous choisissez de supprimer les zones blanches ou noires et indiquez si les zones 
grises doivent être partiellement transparentes. Consultez Utilisation des incrustations en luminance à la page 359.
En plus de ces effets d’incrustation, vous pouvez avoir besoin de recourir à un cache, à un effet 
de positionnement et à un étalonnage pour vous assurer que la vidéo du premier plan reste 
naturelle après son incrustation sur l’arrière-plan. Pour en savoir plus, consultez Finalisation de 
l’incrustation à la page 364.
Un autre moyen de combiner deux plans consiste à utiliser pour le plan de premier plan un canal 
alpha ou de cache définissant les parties du plan à conserver et celles à remplacer par le plan 
d’arrière-plan. Ce procédé est courant lors de l’utilisation d’animations ou de logos générés sur 
ordinateur. Pour en savoir plus, consultez Présentation du compositing à la page 367.
Utilisation des incrustations chromatiques
Pour créer une bonne incrustation chromatique, le plus délicat est de tourner la vidéo à incruster, 
et en particulier d’utiliser un fond adapté et bien éclairé offrant une couleur uniforme à supprimer. Il existe de nombreuses options spécialisées pour le fond d’incrustation chromatique, de la 
peinture contenant des additifs hautement réfléchissants aux vêtements ou feuilles de papier 
spécialement conçus à cet effet. Il est en outre important d’utiliser la meilleure caméra dont 
vous disposez et d’éviter d’avoir recours à un format vidéo hautement compressé tel que DV 
ou MPEG-2.
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Dans les exemples ci-dessous, la femme va être incrustée sur une scène de rue. Les pieds de projecteur seront abordés à la section Finalisation de l’incrustation à la page 364.
Application de l’effet d’incrustation chromatique
1 Sur la timeline, ajoutez le plan de premier plan (plan d’incrustation chromatique contenant la 
couleur à supprimer) au scénario principal.
2 Faites glisser le plan d’arrière-plan (plan sur lequel vous voulez superposer le plan à incruster en 
chrominance) de sorte qu’il soit connecté sous le plan de premier plan dans le scénario principal.
Avant-plan
Arrière-plan 
attaché sous 
forme de plan 
connecté
Pour plus d’informations sur les plans connectés, consultez Connexion de plans pour ajouter des 
prises, des titres et des effets de son synchronisés à la page 110.
3 Sélectionnez le plan de premier plan dans la timeline, puis cliquez sur le bouton Effets de la barre 
d’outils.
Conseil : pour obtenir les meilleurs résultats possibles, positionnez également la tête de lecture 
sur un point du plan de premier plan affichant la quantité maximale de la couleur à incruster.
4 Dans le navigateur d’effets, sélectionnez l’effet Incrustateur.
Conseil : Saisissez « incrustateur » dans le champ de recherche du navigateur d’effets pour trouver rapidement l’effet Incrustateur.Chapitre 12 Incrustation et compositing 350
5 Procédez de l’une des manières suivantes:
• Faites glisser l’effet sur le plan de premier plan de la timeline auquel vous voulez l’appliquer.
• Double-cliquez sur la vignette de l’effet pour l’appliquer au plan sélectionné.
L’effet Incrustateur analyse automatiquement la vidéo pour détecter une couleur dominante 
bleue ou verte, puis se configure pour supprimer la couleur. Si l’incrustation obtenue n’est pas 
correcte ou si vous voulez l’améliorer, vous pouvez ajuster l’effet d’incrustation chromatique.
Ajustement de l’effet d’incrustation chromatique
Dans la procédure suivante, on considère que vous avez déjà appliqué l’effet 
d’incrustation chromatique.
1 Dans la timeline, sélectionnez le plan de premier plan auquel l’effet Incrustateur a été appliqué, 
puis ouvrez l’inspecteur vidéo.
Des commandes permettant de modifier et d’améliorer l’effet Incrustateur apparaissent.
2 Si l’outil Sélectionner n’est pas actif, choisissez-le dans le menu local Outils de la barre d’outils 
(ou appuyez sur la touche A).
3 Pour améliorer l’incrustation à l’aide des commandes disponibles dans le visualiseur, effectuez 
l’une des opérations suivantes en utilisant les commandes Affiner la tonalité et Force :
• Pour identifier des zones du plan de premier plan dans lesquelles la couleur d’incrustation chromatique apparaît toujours: cliquez sur la vignette Exemple de couleur dans l’inspecteur vidéo, puis 
tracez un rectangle dans le visualiseur sur la zone où la couleur d’incrustation chromatique 
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Remarque : Par défaut, l’effet Incrustateur applique un élagage qui affiche en gris tout restant 
de frange de la couleur d’arrière-plan (fond bleu ou vert) à laquelle vous appliquez la transparence. Pour voir la couleur d’origine, définissez le paramètre Niveau de débordement sur 0 %.
Faites glisser sur une zone où 
la couleur de colorimétrie n’est 
pas entièrement retirée.
Pour améliorer l’incrustation, vous pouvez faire glisser le rectangle afin d’ajuster sa position 
ou ses coins pour adapter sa taille. Vous pouvez ensuite faire glisser d’autres rectangles sur 
n’importe quelle zone où la couleur d’incrustation chromatique apparaît toujours.
Conseil : Sélectionnez Cache (bouton central) dans la zone Afficher de l’inspecteur vidéo pour 
afficher le cache créé par l’incrustateur chromatique. Cela peut permettre de détecter plus facilement les zones qui ne sont pas correctement incrustées.
• Pour ajuster avec précision des zones difficiles, telles que les cheveux ou des reflets: cliquez sur la 
vignette Rechercher les bords dans l’inspecteur vidéo, tracez une ligne sur la zone difficile dans 
le visualiseur (avec une extrémité dans la zone à conserver et l’autre dans la zone à supprimer), 
puis faites glisser la poignée de la ligne pour affiner l’adoucissement du contour.
Faites glisser pour régler la frange de l’adoucissement.
Les raccourcis clavier suivants vous permettent d’effectuer vos manipulations directement 
dans le visualiseur :
• Pour procéder au réglage de l’exemple de couleur: tracez un rectangle tout en maintenant la 
touche Maj enfoncée.
• Pour procéder au réglage des bords (contour): tracez une ligne tout en maintenant la touche 
Commande enfoncée.
• Pour supprimer le réglage Exemple de couleur ou Bords: cliquez sur un rectangle Exemple de 
couleur ou sur une ligne Bords tout en maintenant la touche Option enfoncée, ou sélectionnez la commande et appuyez sur la touche Supprimer.Chapitre 12 Incrustation et compositing 352
• Pour choisir une autre couleur si l’effet d’incrustation n’a pas pris la bonne : réglez le paramètre 
Force sur 0 (pour remplacer l’échantillonnage de couleurs initial et automatique). Utilisez 
ensuite Exemple de couleur pour indiquer la couleur à supprimer. Sélectionnez Composite 
(bouton gauche) dans la zone Afficher pour afficher le plan de premier plan combiné au plan 
d’arrière-plan.
• Pour adapter le degré de similitude, déterminé par l’incrustation, entre une couleur sur l’image 
en premier plan et celle de l’incrustation chromatique par défaut: utilisez le curseur Force 
pour régler la tolérance (transparence principal) de l’échantillonnage automatique de l’effet 
d’incrustation. La valeur par défaut est égale à 100 %. La réduction de cette valeur réduit la 
gamme de couleur échantillonnée, provoquant ainsi une transparence moindre dans l’image 
incrustée. À l’inverse, l’augmentation de la valeur Force étend la gamme de couleurs échantillonnée, permettant ainsi une transparence plus poussée dans l’image incrustée. Le paramètre 
Force s’avère utile pour récupérer les zones semi-transparentes telles que les cheveux, la 
fumée ou les reflets.
4 Pour un ajustement précis de l’incrustation, utilisez les options de présentation :
Original (premier 
plan non traité)
Cache (signal alpha basé 
sur le premier plan créé 
par l’incrustateur)
Nom du bouton 
Présentation sélectionné
Montage composite 
(premier plan combiné 
à l’arrière-plan)
• Composite : affiche l’image composite finale, avec le sujet de premier plan incrusté sur le plan 
d’arrière-plan. Il s’agit de la présentation par défaut.
• Cache : affiche le cache en niveaux de gris, ou canal alpha, généré par l’opération d’incrustation. Les zones blanches sont opaques (la vidéo de premier plan est opaque), les zones noires 
sont transparentes (le premier plan est totalement invisible) et les différentes nuances de 
gris représentent les différents niveaux de transparence (la vidéo de l’arrière-plan est combinée avec celle du premier plan). L’affichage du cache permet de détecter plus facilement les 
espaces indésirables dans l’incrustation ou les zones qui ne sont pas assez transparentes.
• Original : affiche l’image de premier plan d’origine non incrustée.
5 Pour affiner le cache, utilisez les commandes suivantes:
• Remplir les espaces: l’augmentation de la valeur de ce paramètre permet d’accroître l’opacité 
des régions présentant une transparence marginale au sein de l’incrustation. Cette commande 
est utile lorsque vous êtes satisfait des bords de votre incrustation mais qu’il reste au sein de 
celle-ci des espaces indésirables que vous ne parvenez pas à éliminer à l’aide du paramètre 
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• Distance des bords: permet d’ajuster la distance du bord du sujet incrusté jusqu’à laquelle 
l’effet Remplir les espaces peut s’étendre. La réduction de la valeur du paramètre rapproche 
la zone remplie du cache du contour du sujet, aux dépens de la translucidité au niveau du 
contour. L’augmentation de sa valeur écarte du contour la zone remplie du cache. Une trop 
grande distance des contours peut entraîner un effet de translucidité indésirable au sein de 
parties du sujet censées être opaques.
6 Pour supprimer une couleur quelconque en arrière-plan apparaissant (effet de débordement) sur 
l’image de premier plan, ajustez le Niveau de débordement.
7 Pour inverser l’opération d’incrustation, en conservant la couleur d’arrière-plan et en supprimant 
l’image de premier plan, sélectionnez Inverser.
8 Pour mélanger l’effet d’incrustation avec la version sans incrustation, ajustez la 
commande Mixage.
Pour en savoir plus sur les ajustements avancés de l’incrustation chromatique, reportez-vous aux 
instructions suivantes.
Ajustements avancés de l’incrustation chromatique
Les commandes suivantes sont proposées dans les cas d’incrustation qui s’avèrent difficiles ou 
pour la correction fine de problèmes spécifiques:
• Appliquer une couleur à la sélection : ces commandes sont prévues pour être utilisées après 
avoir commencé une incrustation à l’aide de l’échantillonnage automatique ou des outils 
Exemple de couleur et Bords. (Vous pouvez cependant ignorer ces outils et créer une incrustation par le biais du mode Manuel décrit ci-dessous.) Les commandes graphiques Colorimétrie 
et Luminance fournissent un moyen d’affiner avec précision la gamme des teintes, la saturation et la luminosité de l’image définissant le cache incrusté.
• Outils Cache : ces commandes permettent d’affiner le cache de transparence généré par les 
paramètres précédemment définis. Ces paramètres ne modifient pas la plage de valeurs 
échantillonnées pour créer un cache incrusté. Ils altèrent en fait le cache généré par les 
commandes de base et avancées de l’effet d’incrustation, vous permettant ainsi de réduire, 
d’agrandir, d’adoucir ou d’inverser le cache pour obtenir un meilleur composite.
• Enveloppe de lumière : ces commandes sont prévues pour la fusion des valeurs de couleur et de 
luminosité à partir de la couche de l’arrière-plan de votre composite et la couche du premier 
plan incrusté. Elles vous permettent de simuler l’interaction de l’éclairage de l’environnement 
avec le sujet incrusté, donnant ainsi l’impression que la lumière à l’arrière-plan enveloppe 
un sujet.
Dans la procédure suivante, on considère que vous avez déjà appliqué l’effet 
d’incrustation chromatique.
1 Dans la timeline, sélectionnez le plan de premier plan auquel l’effet Incrustateur a été appliqué, 
puis ouvrez l’inspecteur vidéo.
Des commandes permettant de modifier et d’améliorer l’effet Incrustateur apparaissent.Chapitre 12 Incrustation et compositing 354
2 Cliquez sur « Appliquer une couleur à la sélection » pour révéler les commandes suivantes:
• Graphique : propose deux options pour définir l’usage des graphiques réglables des commandes Colorimétrie et Luminance pour affiner une incrustation :
• Boîtes de défilement: sélectionnez cette option pour limiter les commandes Colorimétrie et 
Luminance afin d’ajuster l’adoucissement (la transparence des contours) dans le cache que 
vous créez. Dans ce mode, il vous est impossible d’adapter manuellement la tolérance (la 
transparence principale), laquelle se détermine par l’échantillonnage automatique de l’effet 
d’incrustation et par tout rectangle Exemple de couleur ajouté dans le visualiseur. Pour augmenter la tolérance du cache, ajoutez d’autres rectangles Exemple de couleur ou réglez le 
curseur Force.)
• Manuel : sélectionnez cette option pour limiter les commandes Colorimétrie et Luminance 
afin d’ajuster l’adoucissement (la transparence des contours) et la tolérance (la transparence 
principale) dans le cache que vous créez. Assurez-vous que le curseur Force est défini sur 
une valeur supérieure à 0 avant de passer en mode Manuel ; dans le cas contraire, les commandes Colorimétrie et Luminance se trouvent désactivées. Lorsque vous passez en mode 
Manuel, les outils Affiner la tonalité et le curseur Force se désactivent, mais les échantillons 
que vous avez réalisés à l’aide de ces commandes contribuent toujours au cache.
Important : en passant en mode Manuel, il est conseillé de ne pas revenir au mode Boîtes 
de défilement. Pour obtenir les meilleurs résultats possibles, commencez l’incrustation d’une 
image par le biais des outils Exemple de couleur et Bords en mode Boîtes de défilement. 
Activez par la suite le mode Manuel s’il vous semble nécessaire d’affiner votre cache à l’aide 
des commandes Colorimétrie et Luminance. Cependant, si vous revenez au mode Boîtes de 
défilement, vous êtes susceptible de constater des associations inattendues de valeurs échantillonnées en plus et animées avec des images clés, ce qui peut s’avérer difficile à contrôler.Chapitre 12 Incrustation et compositing 355
• Colorimétrie : faites glisser les deux graphiques sur la roue des couleurs en question pour 
régler la gamme isolée des teintes et de saturations contribuant à définir le cache incrusté. 
Le mode sélectionné contrôle quels graphiques présents dans la roue des couleurs sont 
réglables. Le graphique extérieur contrôle l’adoucissement (la transparence des contours) du 
cache que vous créez et peut être réglé en mode Boîtes de défilement ou en mode Manuel. Le 
graphique intérieur contrôle la tolérance (la transparence principale) et n’est ajustable qu’en 
mode Manuel. Faites glisser un des côtés de l’un des deux graphiques pour développer ou 
contracter la bordure du graphique en question, ce qui respectivement ajoute ou soustrait de 
la gamme des teintes et des saturations contribuant à l’incrustation. En mode Manuel, il vous 
est également possible de faire glisser le graphique de tolérance vers l’intérieur pour adapter 
sa position générale dans la roue des couleurs. À gauche de la roue des couleurs se trouve un 
petit graphique affichant la pente de la rotation chromatique, à savoir l’adoucissement relatif 
du contour du cache dans les régions les plus affectées par la commande Colorimétrie. Le glissement du curseur Rotation chromatique (décrit ci-dessous) influe sur la forme de la pente.
Conseil : il est possible d’effectuer un zoom avant et d’adapter la balance autour de la commande Colorimétrie afin d’ajuster les graphiques avec plus de précision. Pour agrandir la 
commande Colorimétrie, placez le pointeur sur la roue des couleurs, puis faites glisser, tout en 
maintenant la touche Z enfoncée, à gauche pour effectuer un zoom arrière ou à droite pour un 
zoom avant. Pour effectuer la balance dans la commande Colorimétrie, maintenez la touche H 
enfoncée tout en faisant glisser le pointeur de la souris dans la roue des couleurs dans le sens 
voulu. Pour rétablir le zoom et recentrer la commande Colorimétrie, placez le pointeur sur la 
commande Colorimétrie et appuyez sur Maj + Z.
• Luminance : faites glisser les poignées réglables dans le dégradé de gris pour modifier la 
gamme isolée du canal de luminance (la gamme de luminosité et celle d’obscurité) qui contribue également à définir le cache incrusté. Les poignées supérieures (qui n’apparaissent qu’en 
mode Manuel) permettent de régler la tolérance (la transparence principale) de la contribution 
du canal de luminance à l’incrustation. Les poignées inférieures ajustent l’adoucissement (la 
transparence des contours) de la contribution du canal de luminance à l’incrustation. Le mode 
Graphique régit quelles poignées sont réglables. En mode Boîtes de défilement, vous avez 
la possibilité de n’ajuster que les poignées inférieures d’adoucissement, ce qui influe sur les 
gammes de luminosité et d’obscurité et, par conséquent, sur la transparence des contours du 
cache. En mode Manuel, il vous est également possible de régler les poignées de tolérance 
supérieures, ce qui modifie la transparence principale dans le canal de luminance du cache. 
Par défaut, la pente des côtés gauche et droit de la représentation graphique de la luminance 
marque une légère courbe en « S ». Vous pouvez modifier la forme de la courbe en ajustant le 
curseur « Rotation de la luminance » (décrit ci-dessous).
Remarque : les poignées d’adoucissement de luminance peuvent s’étendre au-delà des limites 
extérieures de la commande Luminance. Ce comportement, dû à la précision en virgule flottante de l’effet d’incrustation, est parfaitement normal. Pour révéler et déplacer les poignées 
au-delà des limites, faites glisser la courbe de la pente sur la représentation graphique de 
la luminance.
• Rotation chromatique : ce curseur vous permet d’adapter la linéarité de la pente de la rotation chromatique (dans la petite représentation graphique à gauche de la commande 
Colorimétrie). La rotation chromatique modifie l’adoucissement du cache aux contours des 
régions que la commande Colorimétrie affecte le plus. Réduire cette valeur accroît la linéarité 
de la pente de la représentation graphique, ce qui adoucit le contour du cache. À l’inverse, 
augmenter cette valeur accentue la pente, ce qui renforce le contour du cache.Chapitre 12 Incrustation et compositing 356
• Rotation de la luminance : ce curseur vous permet d’adapter la linéarité de la pente de rotation 
de la luminance (les extrémités de la courbe de luminance en forme de cloche reprise dans 
la commande Luminance). La rotation de luminance modifie l’adoucissement du cache aux 
contours des régions que la commande Luminance affecte le plus. Réduire cette valeur accroît 
la linéarité de la pente située entre les poignées supérieures et inférieures de la commande 
Luminance, ce qui adoucit le contour du cache. À l’inverse, l’augmentation cette valeur accroît 
les variations de la courbe, accentuant et rendant ainsi le contour du cache plus abrupt.
• Corriger la vidéo : cochez cette case pour appliquer le lissage au niveau des sous-pixels aux 
composantes de colorimétrie de l’image, réduisant les contours en dents de scie résultant de 
l’incrustation de média comprimé par le biais de la méthode du sous-échantillonnage chromatique 4:2:0, 4:1:1 ou 4:2:2. Bien que cochée par défaut, cette option peut être désactivée si le 
lissage au niveau des sous-pixels dégrade la qualité de vos incrustations.
3 Cliquez sur Outils Cache pour révéler les commandes suivantes:
• Niveaux : utilisez cette commande de dégradé de gris pour adapter le contraste du cache 
incrusté, en faisant glisser les trois poignées prévues pour définir le point noir, le point blanc 
et la pondération (la répartition des valeurs de gris entre le point noir et le point blanc). Le 
réglage du contraste d’un cache peut s’avérer utile pour manipuler les zones translucides de 
l’incrustation afin de les rendre plus opaques (en réduisant le point blanc) ou plus translucides 
(en augmentant le point noir). Faire glisser la poignée Pondération vers la droite entraîne le 
rognage des régions translucides de l’incrustation, tandis que la faire glisser vers la gauche 
rend les régions translucides de l’incrustation plus opaques.
• Noir, Blanc, Pondération : cliquez sur le triangle d’affichage situé dans la rangée Niveaux pour 
révéler les curseurs des paramètres Noir, Blanc et Pondération. Ceux-ci reflètent les réglages 
des poignées Niveaux décrites ci-dessus et vous permettent d’animer avec des images clés 
les trois paramètres Niveaux (via le bouton « Ajouter une image clé » situé à droite de chaque 
curseur). Animer avec des images clés les paramètres Noir, Blanc et Pondération contribue 
à atteindre une meilleure incrustation pouvant s’adapter à des conditions d’écran bleu ou 
vert changeantes.
• Condenser/Développer: faites appel à ce curseur pour manipuler le contraste du cache et 
influer ainsi simultanément sur la translucidité et sur la taille du cache. Faites glisser le curseur 
vers la gauche pour marquer plus encore les régions translucides tout en réduisant le cache. 
À l’inverse, faites glisser le curseur vers la droite pour rendre les régions translucides plus 
opaques tout en développant le cache.
• Adoucir: utilisez ce curseur pour rendre le cache incrusté flou, en adoucissant d’une même 
amplitude le contour.
• Érosion : faites glisser ce curseur vers la droite pour augmenter progressivement la transparence du contour de la partie opaque de l’incrustation en partant de l’intérieur.Chapitre 12 Incrustation et compositing 357
4 Cliquez sur Élagage pour révéler les commandes suivantes:
• Contraste du débordement: utilisez cette commande de dégradé de gris pour adapter le 
contraste de la couleur à supprimer, à l’aide des poignées Point noir et Point blanc (et de leur 
curseur correspondant). La modification du contraste du débordement peut réduire la frange 
grise autour d’un sujet au premier plan. La poignée Point noir (à gauche de la commande du 
dégradé) éclaire la frange des bords trop sombre pour obtenir une vidéo composite réussie. 
La poignée Point blanc (située à droite de la commande du dégradé) obscurcit la frange des 
bords s’avérant trop claire. En fonction du degré de neutralisation du débordement par le curseur Niveau de débordement, ces commandes peuvent avoir un effet plus ou moins marqué 
sur le sujet.
• Noir, Blanc : cliquez sur le triangle d’affichage situé dans la rangée Contraste du débordement 
pour révéler les curseurs pour les paramètres des Point noir et Point blanc. Ces curseurs, qui 
reflètent les réglages des poignées Contraste du débordement décrites ci-dessus, vous permettent d’animer avec des images clés les paramètres Point noir et Point blanc (via le bouton 
« Ajouter une image clé » situé à droite de chaque curseur).
• Nuance : ce curseur permet de restaurer la couleur naturelle du sujet incrusté au premier plan. 
Dans la mesure où les commandes Élagage éliminent le débordement bleu ou vert en désaturant les franges subtiles bleues ou vertes et les reflets sur le sujet, le curseur Nuance vous 
permet d’ajouter des teintes afin de rétablir la couleur naturelle du sujet. Une utilisation excessive de ce paramètre provoque un surnuançage du sujet par la complémentaire de la teinte à 
supprimer (magenta en cas d’usage de fond vert, orange en cas de fond bleu).
• Saturation : faites appel à ce curseur pour modifier la gamme des teintes introduite par le curseur Nuance (lorsque ce dernier est utilisé à des niveaux modérés).
5 Cliquez sur Enveloppe de lumière pour révéler les commandes suivantes:
• Grandeur: utilisez ce curseur pour contrôler l’effet global d’enveloppe de lumière, en réglant la 
profondeur à laquelle l’enveloppe de lumière doit s’étendre sur le premier plan.
• Intensité : permet d’ajuster les niveaux gamma pour éclaircir ou obscurcir l’interaction du 
contour enveloppé par le sujet incrusté au premier plan.
• Opacité : passez par ce curseur pour effectuer un fondu plus ou moins prononcé de l’effet 
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• Mode : utilisez ce menu local pour choisir la méthode de compositing chargée de fusionner les 
valeurs de l’arrière-plan échantillonné et le contour du sujet incrusté. Cinq modes vous sont 
proposés:
• Normale : fusionne de façon uniforme les valeurs claires et sombres sur la couche de l’arrièreplan d’une part, et les contours de la couche du premier plan incrusté d’autre part.
• Éclaircissement: compare les pixels qui se chevauchent entre les couches du premier plan et 
de l’arrière-plan, puis conserve les plus clairs. Cette option est pratique pour créer un effet 
d’enveloppe de lumière sélectif.
• Superposition : superpose les parties les plus claires de la couche de l’arrière-plan sur les 
zones enveloppées de la couche du premier plan incrusté. Cette option est adaptée à un 
effet d’enveloppe de lumière agressif.
• Incrustation : associe la couche de l’arrière-plan et les zones enveloppées de la couche du 
premier plan incrusté de sorte que les parties sombres chevauchantes deviennent plus 
sombres, les zones claires deviennent plus claires et les couleurs s’intensifient.
• Lumière crue : semblable au mode de compositing Incrustation, à la différence que les couleurs sont désactivées.
Animation de l’effet d’incrustation chromatique
Pour compenser les variations des conditions dans le plan de premier plan, vous pouvez effectuer des ajustements Exemple de couleur et Rechercher les bords en plusieurs endroits du plan.
Dans la procédure suivante, on considère que vous avez déjà appliqué l’effet 
d’incrustation chromatique.
1 Positionnez la tête de lecture de la timeline au début du plan.
2 Utilisez les outils Exemple de couleur et Rechercher les bords (décrits plus haut) pour créer une 
bonne incrustation chromatique.
3 Placez la tête de lecture de la timeline sur un point ultérieur du plan où les conditions d’éclairage 
ou de l’arrière-plan changent, rendant l’incrustation chromatique inacceptable.
4 Utilisez à nouveau les outils Exemple de couleur et Rechercher les bords pour créer une bonne 
incrustation chromatique.
5 Pour effectuer des ajustements en d’autres endroits, recommencez les étapes 3 et 4 autant de 
fois que nécessaire.
6 Pour déplacer la tête de lecture d’un point d’ajustement à un autre, utilisez les flèches « Aller à 
l’échantillon ».
Lors de la lecture du plan, les réglages Exemple de couleur et Rechercher les bords varient de 
façon fluide d’un point d’échantillon à un autre. Pour un plus grand contrôle, vous pouvez ajouter des images clés pour la plupart des autres réglages de la section Incrustateur de l’inspecteur 
vidéo. Pour en savoir plus sur l’utilisation d’images clés, consultez la section Présentation de l’animation vidéo à la page 256.
Remarque : les images clés pour les graphiques de colorimétrie et luminance dans les commandes « Appliquer une couleur à la sélection » n’apparaissent que dans l’inspecteur vidéo et 
non dans l’éditeur d’animation vidéo sur la timeline.Chapitre 12 Incrustation et compositing 359
Utilisation des incrustations en luminance
Les incrustations en luminance permettent de réaliser un compositing d’un plan de premier plan 
sur un plan d’arrière-plan en fonction des niveaux de luminance de la vidéo. Ce type d’incrustation est particulièrement utile pour les images fixes, telles que l’image d’un logo sur un arrièreplan noir ou des graphismes générés par ordinateur.
Dans les exemples ci-dessous, cette image de compteur de vitesse va être incrustée sur une 
scène de voiture en extérieur pour créer un effet de réflexion.
Application de l’effet d’incrustation en luminance
1 Dans la timeline, placez la tête de lecture sur le point du plan d’arrière-plan (plan sur lequel vous 
voulez superposer le plan à incruster en luminance) où vous voulez que l’incrustation commence.
2 Dans le navigateur d’événements, sélectionnez la partie du plan de premier plan (plan à incruster en luminance contenant la couleur noire ou blanche à supprimer) que vous voulez incruster 
sur l’arrière-plan, puis choisissez Édition > Connecter au scénario principal (ou appuyez sur la 
toucheQ).
Plan de premier 
plan
Plan d’arrière-plan
Pour en savoir plus sur cette façon de connecter des plans, consultez la section Connexion de 
plans pour ajouter des prises, des titres et des effets de son synchronisés à la page 110.Chapitre 12 Incrustation et compositing 360
3 Sélectionnez le plan de premier plan dans la timeline, puis cliquez sur le bouton Effets de la barre 
d’outils.
4 Dans le navigateur d’effets, sélectionnez l’effet Incrustateur en luminance.
Conseil : Saisissez « incrustateur » dans le champ de recherche du navigateur d’effets pour trouver rapidement l’effet Incrustateur en luminance.
5 Procédez de l’une des manières suivantes:
• Faites glisser l’effet sur le plan de premier plan de la timeline auquel vous voulez l’appliquer.
• Double-cliquez sur la vignette de l’effet pour l’appliquer au plan sélectionné.
L’effet Incrustateur en luminance se configure automatiquement pour supprimer la vidéo noire. 
Si l’incrustation obtenue n’est pas correcte ou si vous voulez l’améliorer, vous pouvez ajuster 
l’effet d’incrustation en luminance.
Ajustement de l’effet d’incrustation en luminance
Dans la procédure suivante, on considère que vous avez déjà appliqué l’effet d’incrustation 
en luminance.
1 Dans la timeline, sélectionnez le plan auquel l’effet Incrustateur en luminance a été appliqué.
2 Ouvrez l’inspecteur vidéo.
La section Effets de l’inspecteur vidéo propose des paramètres permettant d’ajuster l’effet 
Incrustateur en luminance.
3 Pour inverser l’incrustation et supprimer les zones blanches au lieu des zones noires du plan de 
premier plan, sélectionnez Inverser.
4 Pour ajuster les valeurs de blanc et de noir du plan, faites glisser les poignées situées aux extré-
mités de la vignette de dégradé.
Par défaut, ces poignées sont réglées de façon à fournir une incrustation linéaire dans laquelle le 
niveau de luminance contrôle de façon linéaire la transparence du premier plan, où 100 % blanc 
représente une opacité totale et 0 % noir une transparence totale, et 25 % gris conserve 25 pour 
cent de l’image de premier plan. Faites glisser les commandes de blanc et de noir pour modifier 
les valeurs auxquelles la vidéo de premier plan est totalement opaque ou transparente.Chapitre 12 Incrustation et compositing 361
5 Pour ajuster l’adoucissement des bords, réglez la commande « Rotation de la luminance ».
Plus la valeur est élevée, plus les bords sont prononcés, ce qui élimine toute transparence partielle, tandis qu’une valeur faible permet de tirer parti de l’éventuel anticrénelage ou adoucissement des bords.
6 Pour un ajustement précis de l’incrustation, utilisez les options de présentation :
Original (premier 
plan non traité)
Cache (signal alpha basé 
sur le premier plan créé par 
l’incrustateur)
Montage composite 
(premier plan combiné 
à l’arrière-plan)
Nom du bouton 
Présentation 
sélectionné
• Composite : affiche l’image composite finale, avec le sujet de premier plan incrusté sur le plan 
d’arrière-plan. Il s’agit de la présentation par défaut.
• Cache : affiche le cache en niveaux de gris, ou canal alpha, généré par l’opération d’incrustation. Les zones blanches sont opaques, les zones noires sont transparentes et les différentes 
nuances de gris représentent les différents niveaux de transparence. L’affichage du canal alpha 
permet de détecter plus facilement les espaces indésirables dans l’incrustation ou les zones 
qui ne sont pas assez transparentes.
• Original : affiche l’image d’origine non incrustée.
7 Pour ne pas toucher au texte ou aux graphismes légèrement crénelés de l’image, ce qui peut 
améliorer les bords, sélectionnez Conserver RVB.
8 Pour mélanger l’effet d’incrustation avec la version sans incrustation, ajustez la 
commande Mixage.
Pour en savoir plus sur les ajustements avancés de l’incrustation en luminance, reportez-vous aux 
instructions suivantes.
Ajustements avancés de l’incrustation en luminance
Les commandes suivantes sont proposées dans les cas d’incrustation qui s’avèrent difficiles ou 
pour la correction fine de problèmes spécifiques:
• Outils Cache : ces commandes permettent d’affiner le cache de transparence généré par les 
paramètres précédemment définis. Ces paramètres ne modifient pas la plage de valeurs 
échantillonnées pour créer un cache incrusté. Ils altèrent en fait le cache généré par les 
commandes de base et avancées de l’effet d’incrustation, vous permettant ainsi de réduire, 
d’agrandir, d’adoucir ou d’inverser le cache pour obtenir un meilleur composite.
• Enveloppe de lumière : ces commandes sont prévues pour la fusion des valeurs de couleur et de 
luminosité à partir de la couche de l’arrière-plan de votre composite et la couche du premier 
plan incrusté. Elles vous permettent de simuler l’interaction de l’éclairage de l’environnement 
avec le sujet incrusté, donnant ainsi l’impression que la lumière à l’arrière-plan enveloppe 
un sujet.
Dans la procédure suivante, on considère que vous avez déjà appliqué l’effet d’incrustation 
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1 Dans la timeline, sélectionnez le plan auquel l’effet Incrustateur en luminance a été appliqué.
2 Ouvrez l’inspecteur vidéo.
La section Effets de l’inspecteur vidéo propose des paramètres permettant d’ajuster l’effet 
Incrustateur en luminance.
3 Cliquez sur Outils Cache pour révéler les commandes suivantes:
• Remplir les espaces: l’augmentation de la valeur de ce paramètre permet d’accroître l’opacité 
des régions présentant une transparence marginale au sein de l’incrustation. Cette commande 
est utile lorsque vous êtes satisfait des bords de votre incrustation mais qu’il reste au sein de 
celle-ci des espaces indésirables que vous ne parvenez pas à éliminer à l’aide du paramètre 
« Rotation de la luminance » sans affecter les bords.
• Distance des bords: permet d’ajuster la distance du bord du sujet incrusté jusqu’à laquelle 
l’effet Remplir les espaces peut s’étendre. La réduction de la valeur du paramètre rapproche 
la zone remplie du cache du contour du sujet, aux dépens de la translucidité au niveau du 
contour. L’augmentation de la valeur de ce paramètre éloigne la zone remplie du cache du 
contour, ce qui peut faire apparaître des régions de translucidité indésirable au sein de parties 
du sujet censées être opaques.
• Niveaux : utilisez cette commande de dégradé de gris pour adapter le contraste du cache 
incrusté, en faisant glisser les trois poignées prévues pour définir le point noir, le point blanc 
et la pondération (la répartition des valeurs de gris entre le point noir et le point blanc). Le 
réglage du contraste d’un cache peut s’avérer utile pour manipuler les zones translucides de 
l’incrustation afin de les rendre plus opaques (en réduisant le point blanc) ou plus translucides 
(en augmentant le point noir). Faire glisser la poignée Pondération vers la droite entraîne le 
rognage des régions translucides de l’incrustation, tandis que la faire glisser vers la gauche 
rend les régions translucides de l’incrustation plus opaques.Chapitre 12 Incrustation et compositing 363
• Noir, Blanc, Pondération : cliquez sur le triangle d’affichage situé dans la rangée Niveaux pour 
révéler les curseurs des paramètres Noir, Blanc et Pondération. Ceux-ci reflètent les réglages 
des poignées Niveaux décrites ci-dessus et vous permettent d’animer avec des images clés 
les trois paramètres Niveaux (via le bouton « Ajouter une image clé » situé à droite de chaque 
curseur). Animer avec des images clés les paramètres Noir, Blanc et Pondération contribue 
à atteindre une meilleure incrustation pouvant s’adapter à des conditions d’écran bleu ou 
vert changeantes.
• Condenser/Développer: faites appel à ce curseur pour manipuler le contraste du cache et 
influer ainsi simultanément sur la translucidité et sur la taille du cache. Faites glisser le curseur 
vers la gauche pour marquer plus encore les régions translucides tout en réduisant le cache. 
À l’inverse, faites glisser le curseur vers la droite pour rendre les régions translucides plus 
opaques tout en développant le cache.
• Adoucir: utilisez ce curseur pour rendre le cache incrusté flou, en adoucissant d’une même 
amplitude le contour.
• Érosion : faites glisser ce curseur vers la droite pour augmenter progressivement la transparence du contour de la partie opaque de l’incrustation en partant de l’intérieur.
4 Cliquez sur Enveloppe de lumière pour révéler les commandes suivantes:
• Grandeur: utilisez ce curseur pour contrôler l’effet global d’enveloppe de lumière, en réglant la 
profondeur à laquelle l’enveloppe de lumière doit s’étendre sur le premier plan.
• Intensité : permet d’ajuster les niveaux gamma pour éclaircir ou obscurcir l’interaction du 
contour enveloppé par le sujet incrusté au premier plan.
• Opacité : passez par ce curseur pour effectuer un fondu plus ou moins prononcé de l’effet 
d’enveloppe de lumière.
• Mode : utilisez ce menu local pour choisir la méthode de compositing chargée de fusionner les 
valeurs de l’arrière-plan échantillonné et le contour du sujet incrusté. Cinq modes vous sont 
proposés:
• Normale : fusionne de façon uniforme les valeurs claires et sombres sur la couche de l’arrièreplan d’une part, et les contours de la couche du premier plan incrusté d’autre part.
• Éclaircissement: compare les pixels qui se chevauchent entre les couches du premier plan et 
de l’arrière-plan, puis conserve les plus clairs. Cette option est pratique pour créer un effet 
d’enveloppe de lumière sélectif.
• Superposition : superpose les parties les plus claires de la couche de l’arrière-plan sur les 
zones enveloppées de la couche du premier plan incrusté. Cette option est adaptée à un 
effet d’enveloppe de lumière agressif.
• Incrustation : associe la couche de l’arrière-plan et les zones enveloppées de la couche du 
premier plan incrusté de sorte que les parties sombres chevauchantes deviennent plus 
sombres, les zones claires deviennent plus claires et les couleurs s’intensifient.
• Lumière crue : semblable au mode de compositing Incrustation, à la différence que les couleurs sont désactivées.Chapitre 12 Incrustation et compositing 364
Finalisation de l’incrustation
Il arrive souvent que l’image de premier plan contienne des objets que vous ne voulez pas voir 
apparaître dans le composite final. Il peut s’agir d’éléments de production tels que des perches 
de microphone, des pieds de projecteur ou encore les bords de la toile de fond d’incrustation 
chromatique. Vous pouvez également être amené à redimensionner ou à repositionner l’objet 
de premier plan pour l’ajuster à l’arrière-plan. Pour finir, vous pouvez utiliser l’outil d’étalonnage 
pour régler l’aspect du premier plan afin de le faire correspondre à celui de l’arrière-plan.
Final Cut Pro comprend des effets que vous pouvez utiliser à ces fins.
Utilisation de l’effet Masque
1 Dans la timeline, placez la tête de lecture sur le point du plan d’arrière-plan (plan sur 
lequel vous voulez superposer le plan à incruster en chrominance) où vous voulez que 
l’incrustation commence.
2 Dans le navigateur d’événements, sélectionnez la partie du plan de premier plan (plan à incruster 
en chrominance contenant la couleur à supprimer) que vous voulez incruster sur l’arrière-plan, 
puis choisissez Édition > Connecter au scénario principal (ou appuyez sur la toucheQ).
Avant-plan
Arrière-plan 
attaché sous 
forme de plan 
connecté
Pour en savoir plus sur cette façon de connecter des plans, consultez la section Connexion de 
plans pour ajouter des prises, des titres et des effets de son synchronisés à la page 110.
3 Sélectionnez le plan de premier plan.
Dans l’exemple ci-dessus, les pieds de projecteur doivent être supprimés.Chapitre 12 Incrustation et compositing 365
4 Dans la barre d’outils, cliquez sur le bouton Effets.
5 Dans le navigateur d’effets, double-cliquez sur l’effet Masque pour l’appliquer au plan de premier 
plan sélectionné.
Conseil : Saisissez « masque » dans le champ de recherche du navigateur d’effets pour trouver 
rapidement l’effet Masque.
6 Ajustez les quatre coins du masque pour rogner les objets à supprimer, à savoir les pieds de projecteur dans notre cas.
Lors de l’ajustement du masque, veillez à laisser les ombres et autres détails qui permettront de 
rendre l’incrustation plus réaliste par la suite.Chapitre 12 Incrustation et compositing 366
7 Appliquez l’effet d’incrustation approprié au plan de premier plan.
Le compositing du premier plan sur l’arrière-plan est terminé.
Utilisation de l’outil Transformation pour positionner l’image de premier plan
Dans la procédure suivante, on considère que vous avez déjà configuré une incrustation mais 
que vous devez repositionner l’image de premier plan.
1 Sélectionnez le plan de premier plan dans la timeline.
2 Dans le coin inférieur gauche du visualiseur, choisissez Transformer dans le menu local, puis 
déplacez l’image à l’emplacement souhaité. Dans l’exemple ci-dessus, il peut être intéressant de 
déplacer la femme vers la gauche.Chapitre 12 Incrustation et compositing 367
Vous pouvez également redimensionner l’image.
3 Cliquez sur Terminé dans le visualiseur une fois que vous avez terminé de repositionner l’image 
de premier plan.
Compositing
Présentation du compositing
Le compositing consiste à combiner des parties d’au moins deux plans vidéo en une seule 
image. Il existe différentes façons de combiner des images vidéo dans Final Cut Pro :
• Transitions: toutes les transitions vidéo consistent à combiner la fin d’un plan avec le début du 
plan suivant, les deux plans apparaissant donc en même temps pendant la transition. 
• Incrustation : toutes les incrustations consistent à réaliser un compositing d’une image de premier plan sur une image d’arrière-plan.
• Canaux alpha : de nombreux plans vidéo générés par ordinateur présentent un canal alpha 
(masque intégré) définissant avec précision les zones du plan faisant l’objet d’un compositing 
sur un plan d’arrière-plan. Ces canaux ne nécessitent aucune configuration d’incrustation et 
fonctionnent en général automatiquement. De nombreux effets (tels que Transformation et 
Distorsion), générateurs (tels que Formes et Timecode) et titres utilisent les canaux alpha.
• Compositing : chaque plan vidéo de la timeline possède un ensemble de réglages Compositing 
que vous pouvez utiliser pour combiner des plans sans avoir recours aux effets d’incrustation.
Utilisation des canaux alpha
Les canaux alpha permettent de réaliser facilement un compositing d’une image sur une autre. À 
l’aide d’une application comme Motion, logiciel Apple conçu pour fonctionner avec Final Cut Pro, 
vous pouvez créer des images fixes et des plans vidéo possédant des canaux alpha. Les canaux 
alpha peuvent être considérés comme ayant un incrustateur intégré : en effet, lorsque vous utilisez les effets d’incrustation, vous créez un masque qui est utilisé de la même manière qu’un plan 
ayant un canal alpha est utilisé pour le compositing.Chapitre 12 Incrustation et compositing 368
Vous trouverez ci-dessous un exemple de plan avec canal alpha montrant l’image qui remplit le 
canal alpha.
Ci-dessous l’image du canal alpha : les zones blanches définissent les zones de la vidéo faisant 
l’objet d’un compositing sur l’arrière-plan. Les zones grises (qui correspondent à l’ombre dans cet 
exemple) définissent les parties partiellement transparentes de l’image.
Voici comment se présente le composite final sur un plan d’arrière-plan.Chapitre 12 Incrustation et compositing 369
Utilisation d’un plan avec un canal alpha
1 Positionnez la tête de lecture dans la timeline à l’endroit où vous voulez ajouter le plan avec 
canal alpha.
2 Sélectionnez le plan ayant un canal alpha dans le navigateur d’événements, puis choisissez 
Édition > Connecter au scénario principal (ou appuyez sur la toucheQ). 
3 Pour voir les plans composites, placez la tête de lecture au sein du plan que vous venez d’ajouter 
au-dessus du scénario principal.
Plan connecté (premier plan 
du montage composite)
Plan du scénario principal (arrière-plan 
du montage composite)
Le plan est monté en composite au-dessus du plan vidéo du scénario principal, avec le canal 
alpha contrôlant l’opacité de son plan.
Vous pouvez également utiliser les poignées de fondu du réglage Opacité pour ajuster l’opacité 
du plan de premier plan.
Utilisation des réglages de compositing
Les réglages Compositing offrent de nombreuses options pour combiner deux images. Vous 
pouvez effectuer un simple ajustement pour combiner uniformément deux images ou choisir des réglages utilisant le contenu vidéo pour déterminer la façon dont les images doivent 
être combinées.
Utilisation du réglage Opacité
1 Positionnez la tête de lecture dans la timeline à l’endroit où vous voulez ajouter un plan au-dessus du scénario principal.
2 Sélectionnez le plan à ajouter dans le navigateur d’événements, puis choisissez Édition > 
Connecter au scénario principal (ou appuyez sur la toucheQ). 
3 Pour voir les plans composites, placez la tête de lecture au sein du plan que vous venez d’ajouter.
Par défaut, le nouveau plan masque complètement le plan du scénario principal.
4 Pour rendre le nouveau plan partiellement transparent, sélectionnez-le dans la timeline, puis 
ajustez la commande Opacité dans la section Compositing de l’inspecteur vidéo.Chapitre 12 Incrustation et compositing 370
Plus la valeur Opacité est proche de 0 pour cent, plus le plan situé au-dessus du scénario principal est transparent. Vous pouvez également utiliser les poignées de fondu Opacité de l’éditeur 
d’animation vidéo pour ajuster l’opacité du plan composite, ou ajouter des images clés pour que 
la valeur d’opacité change en des points précis.
Choix d’un mode de fusion
1 Positionnez la tête de lecture dans la timeline à l’endroit où vous voulez ajouter un plan au-dessus du scénario principal.
2 Sélectionnez le plan à ajouter dans le navigateur d’événements, puis choisissez Édition > 
Connecter au scénario principal (ou appuyez sur la toucheQ). 
3 Pour voir les plans composites, placez la tête de lecture au sein du plan que vous venez d’ajouter.
Par défaut, le nouveau plan masque complètement le plan du scénario principal.
4 Sélectionnez une option dans le menu local Mode de fusion de la section Compositing de 
l’inspecteur vidéo.
De nombreux réglages de mode de fusion sont disponibles; celui que vous devez utiliser 
dépend du contenu vidéo et de l’apparence que vous voulez obtenir. Vous pouvez par ailleurs 
ajuster la commande Opacité pour rendre le réglage de mode de fusion plus subtil.13
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Présentation de l’étalonnage
Dans tout travail de postproduction, l’étalonnage constitue généralement l’une des dernières 
étapes de finalisation d’un programme monté. Vous pouvez réaliser l’étalonnage de votre 
métrage pour de nombreuses raisons:
• pour vous assurer que les éléments clés de votre programme (comme les tons de peau) pré-
sentent l’apparence souhaitée ;
• pour harmoniser les couleurs tous les plans d’une scène ;
• pour corriger des erreurs de balance de couleurs et d’exposition ;
• pour donner une tonalité particulière, comme pour rendre les scènes plus chaudes ou au 
contraire plus froides;
• pour créer un contraste ou des effets spéciaux en manipulant les couleurs et l’exposition.
Les outils d’étalonnage de Final Cut Pro permettent de contrôler avec précision l’apparence de 
chaque plan de votre projet, y compris les images fixes, grâce au réglage de la balance des couleurs, ainsi que des niveaux d’ombres, de tons intermédiaires et de hautes lumières de chaque 
plan. Final Cut Pro inclut également plusieurs outils automatisés vous permettant de modifier la 
balance et d’étalonner rapidement la couleur dans des plans. Dans Final Cut Pro, vous pouvez :
• équilibrer automatiquement les couleurs: d’un simple clic, neutralisez toute dominante de couleur et augmentez le contraste de l’image Consultez Présentation de la balance des couleurs à 
la page 372.
• harmoniser automatiquement la couleur et l’apparence d’un plan : en deux clics, harmonisez 
les couleurs d’un ou de plusieurs plans avec celles d’un autre plan de votre choix Consultez 
Correspondance automatique des couleurs entre les plans à la page 374.
• ajuster manuellement les couleurs, la saturation et l’exposition : corrigez manuellement la couleur 
d’ensemble du plan ou utilisez des masques de couleur ou de forme pour limiter l’étalonnage 
à une gamme de couleurs ou à une zone de l’image – vous pouvez même ajouter plusieurs 
étalonnages manuels à un plan Consultez Présentation de l’étalonnage manuel à la page 375.
• enregistrer les réglages d’étalonnage et les appliquer à d’autres plans: enregistrez les réglages 
d’étalonnage d’un plan et appliquez-les à d’autres plans dans le projet ou issus d’autres projets Consultez Enregistrement et application de préréglages d’étalonnage à la page 385.
Bien que ces fonctionnalités soient indépendantes les unes des autres, vous pouvez désactiver 
puis activer l’une ou l’autre pour voir quel effet elle a, car l’ordre dans lequel vous les utilisez est 
important. Généralement, il est recommandé d’utiliser ces fonctionnalités dans l’ordre suivant : 
balance des couleurs, correspondance des couleurs, et (le cas échéant) étalonnage manuel.
Final Cut Pro inclut également plusieurs instruments vidéo que vous pouvez utiliser lorsque vous 
étalonnez manuellement votre vidéo. Les instruments permettent de contrôler avec précision les 
niveaux de luminance et de colorimétrie de vos plans vidéo.
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Analyse et balance automatique des couleurs
Présentation de la balance des couleurs
Final Cut Pro prévoie une fonctionnalité de balance automatique des couleurs. Cette fonctionnalité de Final Cut Pro échantillonne les zones les plus sombres et les claires du canal de luminance 
de l’image et ajuste celles-ci afin de neutraliser toute dominante de couleur dans l’image. De 
plus, Final Cut Pro ajuste l’image pour augmenter le contraste, de telle façon que la prise de vue 
occupe la gamme de luminance la plus large possible.
L’image vidéo utilisée comme image référence dépend du fait que le plan a déjà subi une analyse des couleurs ou pas:
• Si le plan a subi une analyse des couleurs, soit pendant l’importation soit dans le navigateur 
d’événements: Le processus d’analyse extrait les informations de balance des couleurs pour 
l’ensemble du plan. Si vous ajoutez une partie du plan ou l’ensemble du plan à un projet, la 
fonctionnalité de balance des couleurs choisit l’image dans le plan du projet qui est la plus 
proche d’un équilibre adéquat. Ceci signifie que si vous ajoutez plusieurs plans partiels à partir 
du même plan dans le navigateur d’événements du projet, chaque plan se voit alors équilibré 
d’après les informations d’analyse pour sa propre section de média.
• Si le plan n’a pas subi d’analyse de couleurs et si vous équilibrez ses couleurs: Vous pouvez définir 
l’image de référence d’un plan sélectionné dans la timeline en plaçant la tête de lecture sur 
cette image dans le plan. Si la tête de lecture se trouve sur un autre plan ou si vous avez sélectionné un plan dans le navigateur d’événements, l’image du milieu du plan est utilisée.
Analyse de la balance des couleurs d’un plan
Pour équilibrer automatiquement les couleurs d’un plan, Final Cut Pro utilise une seule image 
du plan comme image de référence et calcule la correction nécessaire avant de l’appliquer à 
l’ensemble du plan. Analyser la balance des couleurs d’un plan permet à Final Cut Pro de choisir 
une image représentative comme image de référence de la balance des couleurs du plan.
Vous pouvez analyser la balance des couleurs d’un plan lors de son importation, que vous l’importiez depuis une caméra ou un fichier, ou que vous le fassiez glisser directement sur la timeline 
depuis une fenêtre du Finder. Vous pouvez également analyser sa balance des couleurs à tout 
moment dans le navigateur d’événements.
L’analyse de la balance des couleurs d’un plan peut prendre de plusieurs secondes pour les plans 
les plus courts à plusieurs minutes pour les plus longs. Le processus d’analyse prend en outre 
plus de temps si vous analysez les personnes et les problèmes de stabilisation.
Une fois la balance des couleurs d’un plan analysée, vous pouvez activer ou désactiver la correction de la balance des couleurs à tout moment. Par défaut, cette correction est désactivée pour 
les plans figurant dans le navigateur d’événements et activés pour ceux figurant dans la timeline, 
s’ils ont été analysés. Pour en savoir plus sur l’activation et la désactivation de la correction de la 
balance des couleurs, que ce soit dans le navigateur d’événements ou dans la timeline, consultez 
la section Équilibrage des couleurs d’un plan à la page 373.
Analyse de la balance des couleurs pendant l’importation de fichiers
1 Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
2 Sélectionnez les fichiers à importer, puis « Analyser la balance des couleurs » dans la section 
Vidéo de la fenêtre.
3 Cliquez sur Importer.
Les fichiers sont importés et analysés en vue de détecter les problèmes de balance des couleurs.Chapitre 13 Étalonnage 373
Analyse de la balance des couleurs pour les plans glissés depuis le Finder sur la timeline
1 Sélectionnez Final Cut Pro > Préférences (ou appuyez sur les touches Commande + virgule).
2 Dans la fenêtre Préférences de Final Cut Pro, cliquez sur le bouton Importer et sélectionnez 
« Analyser la balance des couleurs » dans la section Vidéo.
Tous les plans que vous faites glisser directement sur la timeline à partir du Finder sont analysés.
Remarque : Lorsque vous modifiez ce réglage dans la fenêtre Préférences, le réglage est également modifié dans toutes les autres fenêtres incluant l’option « Analyser la balance des 
couleurs ».
Analyse de la balance des couleurs pour les plans dans le navigateur d’événements
Lorsque vous analysez la balance des couleurs des plans dans le navigateur d’événements, tous 
les plans qui ont été analysés pendant l’importation sont ignorés.
1 Sélectionnez un ou plusieurs plans dans le navigateur d’événements.
2 Procédez de l’une des manières suivantes:
• Choisissez Modifier > Analyser et corriger.
• Cliquez sur l’un des plans sélectionnés en maintenant la touche Contrôle enfoncée, puis choisissez Analyser et corriger dans le menu contextuel.
3 Dans la fenêtre qui apparaît, sélectionnez « Analyser la balance des couleurs » dans la section 
Vidéo, puis cliquez sur OK.
Équilibrage des couleurs d’un plan
Le réglage de balance des plans dans Final Cut Pro active et désactive automatiquement la correction de la balance des couleurs, que le plan se trouve dans le navigateur d’événements ou 
dans la timeline. L’image utilisée comme image de référence correspond soit à une image choisie 
pendant l’analyse de la balance des couleurs, soit à l’image sur laquelle se trouve la tête de lecture dans la timeline, soit à l’image du milieu du plan. Pour en savoir plus, consultez Présentation 
de la balance des couleurs à la page 372.
Activation ou désactivation de la correction de la balance des couleurs d’un plan
1 Sélectionnez un ou plusieurs plans dans la timeline ou le navigateur.
2 Procédez de l’une des manières suivantes:
• Choisissez Modifier > Couleur de balance (ou appuyez sur Commande +Option + B).
• Choisissez Couleur de balance dans le menu local Améliorations de la barre d’outils.
• Dans la section Couleur de l’inspecteur vidéo, cochez ou décochez la case Balance.
Cliquez ici pour activer ou désactiver la balance.
État d’analyse de 
la balanceChapitre 13 Étalonnage 374
Correspondance automatique des couleurs entre les plans
Votre projet utilise certainement de la vidéo provenant de nombreuses sources. La fonctionnalité 
Correspondance des couleurs permet de s’assurer que toutes les scènes prises dans un même 
lieu présentent le même aspect.
Correspondance des couleurs entre les plans
1 Sélectionnez dans la timeline un ou plusieurs plans que vous voulez ajuster.
2 Procédez de l’une des manières suivantes:
• Choisissez Modifier > Correspondance des couleurs (ou appuyez sur 
Commande +Option + M).
• Choisissez Correspondance des couleurs dans le menu local Améliorations de la barre d’outils.
• Dans la section Couleur de l’inspecteur vidéo, cliquez sur le bouton Choisir en regard de 
Correspondance des couleurs.
Le visualiseur s’adapte pour afficher l’image sur laquelle se trouve la tête de lecture de la timeline 
à droite et l’image sur laquelle se trouve le pointeur à gauche.
Le plan sur lequel se trouve le pointeur représente la 
source de concordance des couleurs. Cliquer pour 
effectuer le preview de la concordance des couleurs.
Le plan sélectionné sur la 
timeline correspond à la cible 
de concordance des couleurs.
3 Faites défiler des plans de la timeline ou du navigateur d’événements afin de trouver une image 
avec l’aspect de couleur que vous voulez respecter, puis cliquez pour prévisualiser cet aspect une 
fois appliqué au plan sélectionné.
Vous pouvez cliquer sur une variété de plans jusqu’à ce que vous trouviez l’aspect que 
vous voulez.
Conseil : Vous pouvez importer une image fixe ayant l’aspect que vous voulez, même si elle n’est 
pas liée à votre projet, pour pouvoir reprendre l’aspect de ses couleurs.
4 Pour accepter l’aspect actuel, cliquez sur Appliquer la correspondance dans la fenêtre 
Correspondance des couleurs.Chapitre 13 Étalonnage 375
Le visualiseur revient à sa configuration normale et les plans de la timeline sélectionnés adoptent 
le nouvel aspect.
Activation ou désactivation des corrections de correspondance des couleurs
Vous pouvez désactiver les corrections de correspondance des couleurs qui ont été appliquées 
à un plan. Cette opération peut être utile pour voir la différence entre le plan original et le 
plan corrigé.
1 Dans la timeline, sélectionnez un plan pour lequel les corrections de correspondance des couleurs ont été appliquées.
2 Cliquez sur la case Correspondance des couleurs dans la section Couleur de l’inspecteur vidéo.
Ajustement manuel des couleurs
Présentation de l’étalonnage manuel
Final Cut Pro inclut un outil d’étalonnage manuel que vous pouvez utiliser pour accomplir une 
large variété d’effets d’étalonnage et d’amélioration des couleurs:
• Appliquez un étalonnage à l’ensemble de l’image : ajustez la teinte de la couleur, la saturation et 
l’exposition pour l’ensemble de l’image du plan. Consultez Étalonnage sur toute l’image à la 
page 375.
• Choisissez une couleur dans l’image à étalonner: par exemple, choisissez un objet de couleur 
claire, comme une chemise ou une voiture, puis utilisez les réglages d’étalonnage pour annuler ou modifier la couleur. Consultez Choix d’une couleur spécifique comme cible à l’aide d’un 
masque de couleur à la page 378.
• Choisissez une zone de l’image à étalonner: tracez un ou plusieurs masques de forme, puis 
appliquez l’étalonnage à l’intérieur ou à l’extérieur des masques. Vous pouvez en outre faire 
changer la position des masques au fil de la lecture du plan. Consultez Ciblage de zones spécifiques à l’aide de masques de forme à la page 380.
Vous pouvez également appliquer plusieurs étalonnages à un seul plan et utiliser les masques de 
formes associés un masque de couleur. Par exemple, il vous est possible d’utiliser un étalonnage 
pour définir l’aspect général de couleur du plan, un deuxième étalonnage pour cibler et changer 
une couleur donnée et un troisième pour cibler une autre couleur ou une zone définie par un 
masque de forme. Consultez les sections Application de plusieurs étalonnages à la page 384 et 
Ajout de masques de formes à un masque de couleur à la page 383.
Vous pouvez effectuer des ajustements manuels de couleur par le biais de la carte accélératrice.
Étalonnage sur toute l’image
Faites appel à la carte accélératrice pour ajuster manuellement la couleur, la saturation et l’exposition d’un plan.
Étalonnage manuel de toute l’image d’un plan
1 Sélectionnez un plan dans la timeline, puis procédez de l’une des façons suivantes:
• Choisissez Fenêtre > Aller à > Afficher le réglage colorimétrique (ou appuyez sur les touches 
Commande + 6).
• Choisissez « Afficher le réglage colorimétrique » dans le menu local Améliorations de la barre 
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• Cliquez sur le bouton Réglage colorimétrique dans la section Couleur de l’inspecteur vidéo. 
(Lorsque vous avez effectué des ajustements du réglage colorimétrique, le bouton change de 
couleur.)
• Cliquez sur le coin supérieur gauche d’un plan dans la timeline et choisissez « Réglage de la 
couleur » dans le menu local.
Cliquez sur cette icône pour 
revenir à l’inspecteur vidéo.
Cliquez sur le bouton 
Réinitialiser pour annuler 
les ajustements opérés 
dans la fenêtre.
Sélectionnez 
l’étalonnage à utiliser.
Faites glisser les 
commandes pour 
modifier les valeurs.
Utilisez les curseurs pour 
modifier les valeurs.
Passez par le menu local 
Action pour créer ou choisir 
un préréglage d’étalonnage.
2 Si le plan contient plusieurs étalonnages appliqués, choisissez l’étalonnage à ajuster dans le 
menu local Correction dans le coin supérieur droit de la carte accélératrice.
3 Pour ajouter ou supprimer une teinte de couleur, cliquez sur Couleur (ou appuyez sur 
Commande + Contrôle + C), puis faites glisser les commandes sur la fenêtre Couleur.
• Pour ajuster la teinte pour l’ensemble de l’image : faites glisser la commande Global (la grande 
commande grise).
• Pour ajuster la teinte dans les zones les plus sombres de l’image : faites glisser la commande 
Ombres (la commande noire).
• Pour ajuster la teinte dans les tons intermédiaires: faites glisser la commande Tons intermédiaires 
(la petite commande grise).
• Pour ajuster la teinte dans les zones les plus claires de l’image : faites glisser la commande Hautes 
lumières (la commande blanche).
En faisant glisser les commandes vers le haut, vous ajoutez de la couleur à la vidéo ; à l’inverse, en 
les faisant glisser vers le bas, vous retirez la couleur (en y ajoutant la couleur opposée). Pour choisir la couleur à ajouter ou à retirer, faites glisser les commandes horizontalement.
Vous pouvez également sélectionner la commande et saisir les valeurs numériques à l’aide des 
curseurs correspondants. 
Conseil : Pour déplacer verticalement la commande Carte accélératrice sélectionnée, appuyez sur 
les touches Flèche vers le haut ou Flèche vers le bas. Dans la fenêtre Couleur, vous pouvez également utiliser la touche Flèche vers la gauche ou Flèche vers la droite pour déplacer la commande 
sélectionnée horizontalement.Chapitre 13 Étalonnage 377
4 Pour ajuster le niveau de colorimétrie du plan, cliquez sur Saturation (ou appuyez sur 
Commande + Contrôle + S), puis faites glisser les commandes sur la fenêtre Saturation. 
• Pour ajuster la saturation pour l’ensemble de l’image : faites glisser la commande Global vers 
la gauche.
• Pour ajuster la saturation dans les zones les plus sombres de l’image : faites glisser la 
commande Ombres.
• Pour ajuster la saturation dans les tons intermédiaires: faites glisser la commande 
Tons intermédiaires.
• Pour ajuster la saturation dans les zones les plus claires de l’image : faites glisser la commande 
Hautes lumières.
Faites glisser les commandes vers le haut pour augmenter le niveau de colorimétrie ou vers le 
bas pour le réduire. Ces commandes ne se déplacent pas horizontalement.
Vous pouvez également sélectionner la commande et saisir les valeurs numériques à l’aide des 
cases de valeur correspondantes. 
5 Pour ajuster le niveau de luminance du plan, cliquez sur Exposition (ou appuyez sur 
Commande + Contrôle + E), puis faites glisser les commandes sur la fenêtre Exposition.
• Pour ajuster l’exposition pour l’ensemble de l’image : faites glisser la commande Global vers 
la gauche.
• Pour ajuster l’exposition dans les zones les plus sombres de l’image : faites glisser la 
commande Ombres.
• Pour ajuster l’exposition dans les tons intermédiaires (similaire à une commande gamma): faites 
glisser la commande Tons intermédiaires.
• Pour ajuster l’exposition dans les zones les plus claires de l’image : faites glisser la commande 
Hautes lumières.
Faites glisser les commandes vers le haut pour augmenter le niveau de luminance ou vers le bas 
pour le réduire. Ces commandes ne se déplacent pas horizontalement.
Vous pouvez également sélectionner la commande et saisir les valeurs numériques à l’aide des 
cases de valeur correspondantes. 
Vous pouvez utiliser l’éditeur de commandes afin d’affecter un raccourci clavier pour activer ou 
désactiver les étalonnages lorsque vous ajustez le réglage colorimétrique, et pour attribuer des 
raccourcis clavier à de nombreuses autres fonctions de réglage colorimétrique. Pour en savoir 
plus, consultez Affichage des raccourcis clavier dans l’éditeur de commandes à la page 474.
Réinitialisation et désactivation de l’étalonnage par la carte accélératrice
1 Dans la timeline, sélectionnez un plan dont vous voulez supprimer les étalonnages.
2 Dans le réglage colorimétrique, effectuez l’une des opérations suivantes:
• Pour réinitialiser la commande sélectionnée à sa position neutre : Appuyez sur la 
touche Supprimer.
• Pour réinitialiser toutes les commandes d’une fenêtre à leur position neutre : cliquez sur le bouton 
Réinitialiser dans le coin supérieur droit de la fenêtre.Chapitre 13 Étalonnage 378
• Pour réinitialiser les trois fenêtres Carte accélératrice à leur position neutre : dans la section Couleur 
de l’inspecteur vidéo, cliquez sur le bouton Réinitialiser à droite du réglage Correction.
Cliquez sur cette 
case pour activer ou 
désactiver l’étalonnage.
Bouton de 
réinitialisation 
des réglages 
colorimétriques
• Pour désactiver les corrections de la carte accélératrice sans les réinitialiser: dans la section 
Couleur de l’inspecteur vidéo, décochez la case de la correction.
L’activation et la désactivation des corrections permettent de voir plus rapidement et plus facilement l’effet de vos ajustements.
Choix d’une couleur spécifique comme cible à l’aide d’un masque de couleur
Un masque de couleur permet d’isoler une couleur particulière de l’image. Vous pouvez appliquer un masque de couleur à un plan pour corriger une couleur spécifique, pour exclure cette 
couleur des corrections du reste de l’image, ou les deux. Par exemple, vous pouvez masquer une 
chemise de couleur claire en arrière-plan qui distrait l’attention du sujet principal d’un plan.
L’utilisation d’un masque de couleur pour contrôler l’étalonnage vous permet de sélectionner 
une couleur, puis d’ajuster cette couleur individuellement (réduction, amélioration ou changement) ou d’ajuster tout sauf cette couleur (par exemple, ajouter une teinte ou réduire les niveaux 
de luminosité ou de colorimétrie).
Ajout d’un masque de couleur à un étalonnage
1 Dans la timeline, sélectionnez un plan avec une couleur que vous voulez désactiver ou améliorer.
2 Cliquez sur le bouton « Ajouter un masque de couleur » dans la section Couleur de 
l’inspecteur vidéo.
Cliquez sur l’icône 
pour ajouter un 
masque de couleur.
La section Masque de couleur apparaît.
Couleur sélectionnée 
du masque
Lorsque le bouton est en 
surbrillance, utilisez la 
pipette pour sélectionner 
la couleur du masque 
dans le visualiseur.
Définit l’adoucissement 
du contourChapitre 13 Étalonnage 379
3 Dans le visualiseur, placez la pipette sur une couleur que vous voulez isoler dans l’image, puis 
faites glisser la souris pour sélectionner la couleur.
Faites glisser le 
point actif pour 
sélectionner la 
couleur à masquer.
Lorsque vous faites glisser la pipette, deux cercles concentriques apparaissent. La taille du cercle 
extérieur détermine la gamme des variations de la couleur sélectionnée qui sont incluses dans 
le masque de couleur. Lorsque vous modifiez la taille du cercle extérieur, l’image devient monochrome, à l’exception de la couleur que vous sélectionnez. Vous pouvez faire glisser un nouveau 
cercle de sélection autant de fois que vous le voulez, pour obtenir de meilleurs résultats.
Remarque : Lorsque vous cessez de faire glisser la souris, l’image reprend son aspect d’origine, 
mais les effets du masque de couleur que vous avez créé deviennent visibles dès que vous commencez à ajuster le réglage colorimétrique. Vous pouvez ensuite revenir à l’inspecteur vidéo et 
utiliser la pipette pour ajuster le masque de couleur, si nécessaire.
4 Pour modifier la gamme de variations de couleur incluse dans le masque, procédez de l’une des 
façons suivantes:
• Pour ajouter des nuances de couleur: maintenez la touche Maj enfoncée, placez la pipette 
sur une couleur que vous voulez ajouter au masque, puis faites glisser pour sélectionner 
la couleur.
• Pour retirer des nuances de couleur: maintenez la touche Option enfoncée, placez la pipette sur 
une couleur que vous voulez retirer du masque, puis faites glisser pour sélectionner la couleur.
5 Pour ajuster le contour du masque de couleur, faites glisser le curseur Adoucissement.
Pour que le visualiseur affiche temporairement le masque de couleur, maintenez la touche 
Option enfoncée puis faites glisser la commande Adoucissement : la couleur blanche indique 
les zones entièrement opaques du masque, la couleur noire les zones situées à l’extérieur du 
masque, et les niveaux de gris les zones transparentes du masque.
6 Pour ajuster les réglages d’étalonnage du masque de couleur, cliquez sur le bouton Réglage colorimétrique dans l’inspecteur vidéo. (Une fois que vous avez ajusté le réglage colorimétrique, le 
bouton change de couleur.)
7 Procédez de l’une des manières suivantes:
• Pour appliquer un étalonnage à la couleur sélectionnée : cliquez sur « Inscrit dans le masque ». 
• Pour appliquer un étalonnage à tout sauf la couleur sélectionnée : cliquez sur Masque extérieur.
Vous pouvez étalonner les zones situées à l’intérieur et à l’extérieur du masque, chaque zone 
possédant son propre ensemble de commandes de réglage colorimétrique. Par exemple, vous 
pouvez sélectionner « Inscrit dans le masque » pour améliorer la couleur ciblée, puis sélectionner 
« Masque extérieur » pour assombrir tout le reste.
8 Ajustez les commandes de la carte accélératrice pour créer l’effet recherché.
Pour en savoir plus sur l’utilisation de la carte accélératrice, consultez la section Étalonnage sur 
toute l’image à la page 375.Chapitre 13 Étalonnage 380
Pour limiter la zone de l’image affectée par un masque de couleur, vous pouvez ajouter un 
masque de forme. Pour en savoir plus, consultez Ajout de masques de formes à un masque de 
couleur à la page 383.
Ciblage de zones spécifiques à l’aide de masques de forme
Un masque de forme définit une zone dans l’image pour que vous puissiez appliquer les étalonnages soit à l’intérieur, soit à l’extérieur de cette zone. Par exemple, vous pouvez être amené à 
accentuer le visage d’un sujet en assombrissant la zone qui l’entoure.
Vous pouvez ajouter plusieurs masques de forme pour définir différentes zones. Il vous est également possible d’animer les formes pour qu’elles suivent une zone lors d’un panoramique de la 
caméra ou un objet qui se déplace pendant la lecture du plan.
Ajout d’un masque de forme
1 Dans la timeline, sélectionnez un plan contenant une zone dont vous voulez désactiver ou amé-
liorer la couleur.
2 Cliquez sur le bouton « Ajouter un masque de forme » dans la section Couleur de 
l’inspecteur vidéo.
Cliquez sur l’icône 
pour ajouter un 
masque de forme.
Une zone Masque de forme apparaît.
Cliquez sur ce bouton pour 
afficher ou masquer les 
commandes de masque de 
forme à l’écran.Chapitre 13 Étalonnage 381
3 Pour ajuster la forme par défaut qui apparaît dans le visualiseur, procédez de l’une des façons 
suivantes:
Faites glisser cette poignée 
pour que la forme adopte une 
forme rectangulaire.
Faites glisser le bord 
extérieur pour contrôler 
l’atténuation.
Faites glisser l’une 
de ces poignées pour 
modifier la largeur ou 
la hauteur de la forme.
Faites glisser le cercle 
central pour déplacer 
la forme.
Faites glisser cette 
poignée pour faire 
pivoter la forme.
• Pour positionner la forme : faites glisser son centre.
• Pour ajuster la largeur ou la hauteur de la forme : faites glisser les poignées situées sur les quatre 
points à 90 degrés (en haut, en bas, à gauche ou à droite) du cercle intérieur. Vous pouvez 
maintenir enfoncée la touche Maj pendant que vous faites glisser une poignée pour que tous 
les côtés soient redimensionnés proportionnellement.
• Pour contrôler la rondeur de la forme : faites glisser la poignée vers la gauche de la poignée 
supérieure du cercle intérieur.
• Pour faire pivoter la forme : faites glisser la poignée de rotation (à l’opposé du centre).
• Pour contrôler l’atténuation du contour de la forme : faites glisser le cercle extérieur. Lorsque le 
cercle extérieur est à proximité du cercle intérieur, le contour est prononcé et la transition vers 
les étalonnages que vous appliquez est brutale ; lorsque le cercle extérieur est à distance du 
cercle intérieur, le contour s’adoucit et la transition est plus progressive.
• Pour masquer les commandes du masque : dans la section Couleur de l’inspecteur vidéo, cliquez 
sur le bouton des commandes à l’écran Masque de forme de la zone Masque de forme.
4 Pour ajuster les réglages d’étalonnage du masque de forme, cliquez sur le bouton Réglage colorimétrique dans l’inspecteur vidéo. (Une fois que vous avez ajusté le réglage colorimétrique, le 
bouton change de couleur.)
5 Procédez de l’une des manières suivantes:
• Pour appliquer un étalonnage à la zone de forme : cliquez sur « Inscrit dans le masque ».
• Pour appliquer un étalonnage à tout, à l’exception de la zone de forme : cliquez sur 
Masque extérieur.
Vous pouvez étalonner les zones situées à l’intérieur et à l’extérieur du masque, chaque zone 
possédant son propre ensemble de commandes de réglage colorimétrique. Par exemple, vous 
pouvez sélectionner « Inscrit dans le masque » pour améliorer la zone de la forme, puis sélectionner « Masque extérieur » pour assombrir tout le reste.
6 Ajustez les commandes de la carte accélératrice pour créer l’effet recherché.
Pour en savoir plus sur l’utilisation de la carte accélératrice, consultez la section Étalonnage sur 
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7 Pour ajouter des formes à l’étalonnage, cliquez à nouveau sur le bouton « Ajouter un masque de 
forme » dans la zone de l’étalonnage de l’inspecteur vidéo.
Une autre forme par défaut apparaît dans le visualiseur et la forme d’origine est estompée. Vous 
pouvez sélectionner et continuer à configurer la forme d’origine en cliquant sur son centre.
Suppression d’un masque de forme
1 Dans l’inspecteur vidéo, sélectionnez l’élément Masque de forme à supprimer.
Sélectionnez un 
élément de masque 
de forme et appuyez 
sur suppr.
2 Appuyez sur la touche Supprimer.
Remarque : Si tous les masques de forme de l’étalonnage sont supprimés, les étalonnages 
« Inscrit dans le masque » sont appliqués à l’ensemble de l’image.
Animation d’un masque de forme
Vous pouvez utiliser des images clés pour animer un masque de forme afin qu’il suive le mouvement d’un objet à l’écran.
1 Pour ajouter un masque de forme, suivez les instructions de la rubrique « Ajout d’un masque de 
forme » ci-dessus.
2 Dans la timeline, placez la tête de lecture sur le plan contenant le masque de forme, au niveau de 
l’image où vous voulez que la forme commence à bouger.
3 Positionnez le masque de forme dans sa position de départ dans le visualiseur.
4 Dans l’inspecteur vidéo, cliquez sur le bouton Image clé.
Cliquez ici pour ajouter 
une image clé.
Une image clé est ajoutée au niveau de la tête de lecture. Vous pouvez le voir dans la timeline en 
appuyant sur les touches Contrôle + V pour ouvrir l’éditeur Animation vidéo. L’image clé s’affiche 
dans la section Couleur sous la forme d’un losange au niveau de la tête de lecture.
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5 Placez la tête de lecture sur le point suivant dans le plan, à l’endroit où vous voulez définir la 
position du masque de forme, repositionner le masque de forme et ajouter la seconde image clé.
6 Pour repositionner le masque de forme dans le plan, continuez d’ajouter des images clés jusqu’à 
ce que vous ayez défini le mouvement voulu de la forme.
Après avoir ajouté toutes les images clés, vous pouvez lancer la lecture du plan et voir le masque 
de forme se déplacer entre elles. Pour en savoir plus sur l’utilisation d’images clés, consultez la 
section Présentation de l’animation vidéo à la page 256.
Ajout de masques de formes à un masque de couleur
Souvent, lorsque vous créez un masque de couleur, davantage de zones de la vidéo sont affectées par celui-ci que nécessaire. Par exemple, supposons que vous vouliez étalonner une voiture 
rouge sur le côté gauche de l’écran et ne pas toucher à un panneau de stop rouge à droite. Dans 
ce cas, vous pouvez ajouter un ou plusieurs masques de forme pour limiter le masque de couleur 
aux zones définies par les masques de forme.
Ajout d’un masque de forme à un masque de couleur
1 Sélectionnez un plan dans la timeline et utilisez l’inspecteur vidéo pour y ajouter un masque 
de couleur.
2 Appliquez un étalonnage à l’aide de la carte accélératrice et notez les zones de la vidéo que vous 
ne voulez pas que le masque de couleur modifie.
Pour en savoir plus sur l’utilisation de la carte accélératrice, consultez la section Étalonnage sur 
toute l’image à la page 375.
3 Dans l’inspecteur vidéo, cliquez sur le bouton « Ajouter un masque de forme » dans l’étalonnage 
contenant le masque de couleur.
Cliquez sur l’icône pour 
ajouter un masque de 
forme à l’étalonnage.
4 Ajustez le masque de forme de sorte qu’il chevauche la partie du masque de couleur que vous 
voulez utiliser.
5 Pour ajuster les réglages d’étalonnage, cliquez sur le bouton Réglage colorimétrique dans 
l’inspecteur vidéo. (Une fois que vous avez ajusté le réglage colorimétrique, le bouton change de 
couleur.)
6 Effectuez l’une des opérations suivantes:
• Pour n’appliquer des retouches d’étalonnage qu’aux zones dans lesquelles le masque de couleur 
et le masque de forme se chevauchent: Sélectionnez « Inscrit dans le masque » au bas du 
réglage colorimétrique.
• Pour appliquer des retouches d’étalonnage à l’extérieur des zones dans lesquelles le masque de couleur et le masque de forme se chevauchent: sélectionnez Masque extérieur.
Si nécessaire, vous pouvez ajouter des masques de forme, voire les animer.Chapitre 13 Étalonnage 384
Application de plusieurs étalonnages
Vous pouvez appliquer plusieurs étalonnages à un plan pour cibler des problèmes spécifiques. 
Il est par exemple possible d’utiliser un étalonnage pour masquer une chemise orange clair et un 
autre pour améliorer la couleur verte de la pelouse.
Les masques de couleur sont créés en fonction des couleurs originales du plan. Par exemple, si le 
premier étalonnage supprime toute la colorimétrie du plan, le second étalonnage peut créer un 
masque de couleur selon une couleur d’origine du plan.
Application de plusieurs étalonnages à un plan
1 Sélectionnez un plan dans la timeline.
2 Pour ajouter un élément d’étalonnage supplémentaire, cliquez sur le bouton Ajouter une 
connexion dans l’inspecteur vidéo.
Cliquez sur ce bouton pour 
ajouter un étalonnage.
Par défaut, la section Couleur contient le premier élément d’étalonnage manuel (Correction 1) 
ainsi que les éléments Balance et Correspondance des couleurs. Les éléments d’étalonnage que 
vous ajoutez s’intitulent Correction 2, Correction 3, etc. Chaque élément d’étalonnage possède son 
propre bouton Réglage colorimétrique. Lorsque vous cliquez sur l’un d’eux, le réglage colorimé-
trique s’ouvre avec les réglages de l’étalonnage en question. Vous pouvez également choisir un 
étalonnage dans le réglage colorimétrique à l’aide du menu local situé dans le coin supérieur droit.
Remarque : Si vous avez appliqué plusieurs corrections à un plan, vous pouvez les faire glisser dans 
l’inspecteur vidéo pour modifier leur ordre. La modification de l’ordre de traitement peut offrir 
différents résultats.
Affichage des images clés d’étalonnage dans la timeline
Si un plan contient plusieurs étalonnages avec des masques de forme animés, vous pouvez afficher 
les images clés du ou des masques de forme d’un étalonnage dans l’éditeur d’animation vidéo audessus du plan dans la timeline.
1 Dans la timeline, sélectionnez un plan auquel ont été appliqués plusieurs étalonnages avec des 
masques de forme animés.
2 Choisissez Plan > Afficher l’animation vidéo (ou appuyez sur Contrôle + V).
3 Dans le menu local Couleur, choisissez l’étalonnage que vous voulez voir :
• Pour afficher un composite d’images clés à partir de tous les étalonnages: choisissez l’étalonnage 
voulu et, si le plan contient plusieurs masques de forme, choisissez celui que vous voulez afficher.Chapitre 13 Étalonnage 385
• Pour afficher les images clés à partir d’un masque de forme spécifique dans un étalonnage : choisissez l’étalonnage voulu et, si le plan contient plusieurs masques de forme, choisissez celui 
que vous voulez afficher.
Lorsque vous choisissez une correction donnée, Correction 2 par exemple, ses images clés 
s’affichent en blanc et les images clés des autres corrections en gris foncé.
Ajout d’une transition entre des étalonnages
Vous pouvez utiliser une transition pour qu’un plan vidéo passe d’un étalonnage à un autre. Par 
exemple, si vous voulez qu’une scène mette progressivement en valeur les deux personnages 
principaux, vous pouvez utiliser une transition pour passer en fondu du plan normal au plan avec 
masques de forme et appliquer un étalonnage pour assombrir l’image en dehors des masques.
Important : Assurez-vous que l’option Données disponibles est sélectionnée dans le menu local 
« Appliquer les transitions utilisant » de la fenêtre Montage des préférences de Final Cut Pro. Pour 
en savoir plus sur ce réglage, consultez la section Création des transitions à la page 213.
Configuration d’un plan pour changer de transition
1 Passez temporairement à l’outil Lame de rasoir en maintenant la touche B enfoncée.
2 Dans la timeline, cliquez sur un plan vidéo à l’endroit où vous voulez passer d’un étalonnage à 
un autre.
Le plan se divise en deux.
3 Appliquez un étalonnage différent à chaque plan.
Vous pouvez aussi laisser un plan sans étalonnage et en appliquer un à l’autre. L’étalonnage peut 
représenter une teinte franche, un changement d’exposition ou tout autre ajustement visible.
4 Sélectionnez le point de montage entre les deux plans et appuyez sur les touches 
Commande +T pour insérer un fondu enchaîné.
Pendant la lecture du plan, le premier étalonnage laisse progressivement la place au second au 
passage du point de montage.
Enregistrement et application de préréglages d’étalonnage
Final Cut Pro vous permet d’enregistrer les réglages d’étalonnage d’un plan sous un préréglage, 
ce qui facilite son application à d’autres plans du même projet ou d’un autre.
Final Cut Pro inclut plusieurs préréglages que vous pouvez utiliser en plus de ceux que 
vous créez.
Remarque : Les préréglages d’étalonnage enregistrent uniquement les réglages de Couleur, de 
Saturation et d’Exposition. Ils ne permettent pas d’enregistrer les réglages du masque, notamment si les options « Inscrit dans le masque » ou Masque extérieur sont sélectionnées.
Enregistrement d’un préréglage d’étalonnage
1 Dans la timeline, sélectionnez un plan comportant l’aspect d’étalonnage que vous voulez enregistrer et ouvrez la carte accélératrice.
2 Dans le menu local Action situé dans le coin inférieur droit de la carte accélératrice, 
choisissez Enregistrer.
3 Attribuez un nom au préréglage, puis cliquez sur OK.Chapitre 13 Étalonnage 386
Application d’un préréglage d’étalonnage
1 Sélectionnez un plan dans la timeline et ouvrez la carte accélératrice.
2 Dans le menu local Action situé dans le coin inférieur droit de la carte accélératrice, choisissez un préréglage.
Les ajustements du préréglage s’appliquent à la sélection. Une fois le préréglage appliqué, vous 
pouvez modifier les réglages à l’aide de la carte accélératrice.
Activation et désactivation des ajustements iMovie
Lors du montage d’un projet dans iMovie, vous pouvez ajuster différents attributs vidéo, comme 
l’exposition, la luminosité et la saturation, dans le navigateur de projets. Si vous importez un 
projet iMovie contenant ces ajustements dans Final Cut Pro, les ajustements sont conservés et 
apparaissent dans la zone Couleur de l’inspecteur vidéo sous la forme d’un élément iMovie.
Bien que vous ne puissiez pas modifier les ajustements ajoutés dans iMovie, vous pouvez choisir 
de les appliquer au plan ou pas.
Remarque : Les ajustements vidéo que vous effectuez sur les plans dans le navigateur d’événements d’iMovie ne sont pas conservés et n’apparaissent pas dans Final Cut Pro.
Activation ou désactivation des ajustements iMovie d’un plan
m Dans la timeline, sélectionnez un plan pour lequel les ajustements iMovie sont appliqués, et 
cochez ou décochez la case iMovie dans la zone Couleur de l’inspecteur vidéo.
Cliquez sur cette case pour activer ou 
désactiver les ajustements iMovie.
Remarque : Les ajustements iMovie apparaissent uniquement dans la timeline mais pas dans le 
navigateur d’événements.
Pour en savoir plus sur l’importation de projets iMovie, consultez la section Importation à partir 
d’iMovie à la page 35.
Mesure de niveaux vidéo
Présentation des instruments vidéo
Les studios de télédiffusion fixent des valeurs maximales de luminance et de colorimétrie autorisées pour la diffusion. Si un programme vidéo dépasse ces limites, une distorsion de l’image 
risque de se produire : couleurs débordant les unes sur les autres, blancs et noirs ternis ou encore 
signal vidéo empiétant sur l’audio et entraînant une distorsion perceptible du son. Dans tous 
ces cas, le dépassement des niveaux standard entraîne une qualité de transmission inacceptable. Lors de l’étalonnage des plans de votre projet, vous pouvez utiliser les instruments vidéo 
de Final Cut Pro pour vous assurer que les niveaux de luminance et de colorimétrie de votre 
vidéo sont compris dans la plage des paramètres considérés comme adaptés à la télédiffusion 
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Même si votre projet n’est pas destiné à la diffusion, l’utilisation des instruments vidéo constitue 
une étape importante de votre flux de production. Si les moniteurs que vous utilisez n’affichent 
pas les couleurs de façon cohérente ou si vous travaillez sur les mêmes plans depuis un moment, 
il se peut que vous vous soyez habitué à voir une dominante de couleur ou des niveaux de noir 
légèrement incorrects. Les instruments vous fournissent une mesure exacte des niveaux de luminance et de colorimétrie de vos plans pour que vous puissiez ajuster de façon plus pertinente 
vos réglages d’étalonnage de Final Cut Pro.
Final Cut Pro propose les vidéoscopes suivants:
• oscilloscope,
• vecteurscope,
• histogramme.
Utilisation des instruments vidéo
Par défaut, les vidéoscopes s’affichent à gauche de l’image vidéo dans le visualiseur et dans le 
visualiseur d’événements. Chaque visualiseur n’affiche qu’un instrument à la fois.
Ouverture d’un instrument
1 Procédez de l’une des manières suivantes:
• Pour ouvrir un instrument vidéo dans le visualiseur: Choisissez Fenêtre > Affichage du visualiseur > Afficher les instruments vidéo (ou appuyez sur Commande + 7).
• Pour ouvrir un instrument vidéo dans le visualiseur d’événements: choisissez Fenêtre > Affichage 
du visualiseur d’événements > Afficher les instruments vidéo.
Que ce soit dans le visualiseur comme dans le visualiseur d’événements, vous pouvez aussi 
« Afficher les instruments vidéo » à partir du menu local des options du visualiseur qui se trouve 
dans le coin supérieur droit.
Vous pouvez utiliser les mêmes commandes pour fermer l’instrument vidéo.
2 Choisissez l’instrument pour afficher la section supérieure du menu local Réglages.
Choisissez dans le 
menu local Réglages 
l’instrument à utiliser.
Menu local 
des options du 
visualiseur
3 Après avoir choisi un instrument, sélectionnez les options d’affichage dans la section inférieure 
du menu local Réglages.
Remarque : Il peut s’avérer pratique d’afficher les instruments sous l’image vidéo dans le visualiseur d’événements. Pour ce faire, choisissez Présenter verticalement dans le menu local Réglages 
du visualiseur d’événements. Pour en savoir plus, consultez Lecture et survol du média dans le 
visualiseur d’événements à la page 83.Chapitre 13 Étalonnage 388
Options d’affichage de l’oscilloscope
L’oscilloscope indique les niveaux relatifs de luminance et de colorimétrie du plan en cours 
d’étude. Ces valeurs s’affichent de gauche à droite et reflètent la répartition relative de ces 
niveaux de gauche à droite dans l’image. Les crêtes et creux des formes d’onde affichées correspondent aux tâches lumineuses et aux zones sombres de votre image. Les formes d’onde sont 
également de couleur afin d’identifier facilement les éléments de la vidéo.
Le menu local Réglages dans le coin supérieur droit de l’oscilloscope fournit de nombreuses 
options d’affichage :
• Parade RVB : se présente sous la forme de trois oscilloscopes simultanés affichant respectivement les composantes rouge, vert et bleu de la vidéo. Les formes d’onde sont de couleur 
rouge, verte et bleue afin d’être facilement identifiables.
L’instrument Parade RVB est utile pour comparer les niveaux relatifs de rouge, de vert et de 
bleu de deux plans. Si un plan comporte plus de bleu qu’un autre, l’oscilloscope affiche une 
forme d’onde bleue élevée pour le plan contenant plus de bleu et une forme d’onde bleue en 
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• Incrustation RVB : associe les formes d’onde pour les composantes de couleur rouge, verte et 
bleue d’un affichage.
• Rouge : affiche uniquement le canal de couleur rouge.
• Vert: affiche uniquement le canal de couleur verte.
• Bleu : affiche uniquement le canal de couleur bleue.
• Luminance : affiche uniquement la composante de luminance de la vidéo.
• Colorimétrie : affiche uniquement la composante de colorimétrie de la vidéo et affiche des couleurs correspondant à celles de la vidéo.Chapitre 13 Étalonnage 390
• Parade Y’CbCr: présente trois affichage de forme d’onde l’un à côté de l’autre pour la 
luminance, le Cb (le canal de différence de couleur des nuances bleues) et le Cr (le canal 
de différence de couleur des nuances rouges). Les formes d’onde sont teintées en blanc 
(luminance), en magenta (pour le Cb) et en jaune (pour le Cr) afin d’identifier facilement 
chaque composant.
• IRE : affiche la plage du signal vidéo en unités IRE.
• Millivolts: affiche la plage du signal vidéo en millivolts.
• Guides: active ou désactive la grille de l’oscilloscope et les valeurs numériques.
• Monochrome : réduit l’intensité et désature l’affichage de l’instrument pour empêcher les distractions visuelles et les problèmes de perception des couleurs dans votre suite de finalisation 
des couleurs.
• Luminosité : définit la luminosité ou l’obscurité relative de l’affichage de l’instrument.
Options d’affichage du vecteurscope
Le vecteurscope indique la distribution de la couleur dans votre image sur une échelle circulaire. 
La couleur de votre vidéo est représentée par un ensemble de points reliés qui se trouvent dans 
cette échelle. L’angle autour de l’échelle correspond à la teinte affichée, tandis que les cibles 
indiquent les couleurs primaires (rouge, vert et bleu) et secondaires (jaune, cyan et magenta). 
La distance entre le centre de l’échelle et l’anneau externe représente la saturation de la couleur affichée. Le centre de l’échelle correspond à une saturation nulle, l’anneau externe à une 
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Le vecteurscope permet de connaître la teinte et l’intensité des différentes couleurs de l’image. 
Lorsque vous saurez identifier les couleurs de vos plans sur le vecteurscope, vous serez en 
mesure d’identifier les points de divergence de deux images et de les corriger afin de les harmoniser autant que possible.
Le menu local Réglages dans le coin supérieur droit du vecteurscope fournit de nombreuses 
options d’affichage :
• 100%: définit le niveau de colorimétrie de référence pour les cibles des mires (les carrés repré-
sentant chaque couleur dans un signal de test de couleur standard) sur une colorimétrie saturée à 100 %. Utilisez cette option lorsque votre média source utilise des mires de 100 pour cent 
comme référence.
• 133%: définit le niveau de colorimétrie de référence pour les cibles des mires sur une colorimétrie saturée à 75 %. Utilisez cette option lorsque votre média source utilise des mires de 
75 pour cent comme référence.
• Vecteur: utilise un niveau de teinte de colorimétrie normal, le rouge étant situé dans la 
partie supérieure.
• Mark3 : utilise un niveau de teinte de colorimétrie à 90 degrés, le rouge étant situé sur le 
côté droit.
• Afficher/masquer l’indicateur de teinte de peau : affiche ou masque la diagonale qui représente la 
colorimétrie de teinte de la peau humaine, qui se situe entre les cibles de mires jaune et rouge.
• Monochrome : réduit l’intensité et désature l’affichage de l’instrument pour empêcher les distractions visuelles et les problèmes de perception des couleurs dans votre suite de finalisation 
des couleurs.
• Luminosité : définit la luminosité ou l’obscurité relative de l’affichage de l’instrument.
Options d’affichage de l’histogramme
L’histogramme fournit une analyse statistique de l’image en calculant le nombre total de pixels 
de chaque couleur ou le niveau de luminance, et en créant un graphique qui reprend le nombre 
de pixels à chaque pourcentage de luminance ou de couleur. Chaque unité incrémentielle de 
l’échelle de gauche à droite représente un pourcentage de luminance ou de couleur, et la hauteur de chaque segment du graphique de l’histogramme indique le nombre de pixels correspondant à ce pourcentage.Chapitre 13 Étalonnage 392
Le menu local Réglages dans le coin supérieur droit de l’histogramme fournit de nombreuses 
options d’affichage :
• Luminance : affiche uniquement la composante de luminance de la vidéo. La hauteur du 
graphique de chaque degré de l’échelle représente le nombre de pixels de l’image pour ce 
pourcentage de luminance, par rapport à toutes les autres valeurs. Par exemple, si une image 
comporte peu de tons clairs, l’histogramme affiche un grand groupe de valeurs dans les 
tons intermédiaires.
À l’aide de l’histogramme de luminance, vous pouvez rapidement comparer la luminance de 
deux plans afin d’harmoniser les noirs, les tons intermédiaires et les blancs.
La forme de l’histogramme permet également de déterminer le contraste dans une image. 
Une image à faible contraste affiche un groupe de valeurs concentré sur le centre du graphique. À titre de comparaison, une image au contraste extrêmement élevé affiche une distribution plus répartie des valeurs sur toute la largeur du graphique.
• Incrustation RVB : associe les formes d’onde pour les composantes de couleur rouge, verte et 
bleue d’un affichage. Si l’image étudiée présente des niveaux équivalents de deux couleurs ou 
plus, la couleur associée apparaît :
• Des niveaux équivalents de vert et de bleu apparaissent comme du cyan.
• Des niveaux équivalents de vert et de rouge apparaissent comme du jaune.
• Des niveaux équivalents de rouge et de bleu apparaissent comme du magenta.
• Des niveaux équivalents de rouge, de vert et de bleu apparaissent comme du gris.Chapitre 13 Étalonnage 393
• Parade RVB : Présente trois graphiques qui affichent votre vidéo sous la forme de composantes 
séparées de rouge, de vert et de bleu. Les formes d’onde sont de couleur rouge, verte et bleue 
afin d’être facilement identifiables.
Vous pouvez utiliser la présentation Parade RVB pour comparer la répartition relative de 
chaque canal de couleur sur la plage de couleurs globale de l’image. Par exemple, les images 
avec une dominante de couleur rouge présente soit un graphique rouge largement plus élevé, 
soit des graphiques vert et bleu plus faibles.
• Rouge : affiche uniquement le canal de couleur rouge.
• Vert: affiche uniquement le canal de couleur verte.
• Bleu : affiche uniquement le canal de couleur bleue.
• Luminosité : définit la luminosité ou l’obscurité relative de l’affichage de l’instrument.14
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Présentation du partage de projets
Final Cut Pro fournit un grand nombre de destinations, c’est-à-dire de réglages d’exportation pré-
configurés, que vous pouvez utiliser pour générer la sortie de votre projet ou plan. Par exemple, 
vous pouvez exporter un projet ou un plan sous forme de séquence QuickTime, l’exporter en vue 
de son visionnage sur des dispositifs Apple tels que l’iPhone et l’iPad, le publier sur des sites web 
comme Facebook et YouTube, ou encore le graver sur disque. Chacune de ces options fait appel 
à une destination différente.
Lorsque vous ouvrez Final Cut Pro pour la première fois, un ensemble de destinations par défaut 
apparaît dans le sous-menu Partager du menu Fichier et dans le menu local Partager. 
Les détails sur chaque destination de l’ensemble par défaut sont répertoriés dans le tableau 
ci-dessous. 
Destination Permet de
DVD Graver votre projet sur un DVD en définition standard.
Fichier original (par défaut) Exporter un projet en tant que fichier de 
séquence QuickTime.
La destination du fichier original est celle par défaut. 
Vous pouvez l’ouvrir en appuyant sur Commande + E.
YouTube
Vimeo
Facebook
Publier le projet à travers un compte sur un de ces 
sites web.
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Destination Permet de
Dispositifs Apple 720p Exporter des fichiers pour l’iPhone et l’iPod. 
Dispositifs Apple 1080p Exporter des fichiers pour l’iPad. 
Vous avez la possibilité de remplacer en toute simplicité l’ensemble par défaut de destinations 
par vos propres destinations personnalisées. Pour modifier des destinations et en créer, utilisez la 
fenêtre Destinations des préférences de Final Cut Pro. Il vous est également possible de créer un 
lot de destinations pour exporter plusieurs types de sortie en une seule fois. Pour en savoir plus, 
consultez Utilisation de destinations à la page 447. 
Pour personnaliser davantage votre sortie, vous pouvez faire appel à Compressor, l’application 
professionnelle de transcodage. Pour en savoir plus, consultez Exportation d’un projet par le biais 
de Compressor à la page 403.
Partage de projets, de plans et de plages
Vous pouvez partager un projet ou un plan, en entier ou en partie (dans ce dernier cas, la section 
est indiquée par une sélection de plage). Il vous est également possible de partager les rôles 
d’un projet, en exportant chaque rôle sous forme de stem à part. Si vous comptez par la suite 
exporter les mêmes rôles d’un projet ou plan à un autre, vous pouvez enregistrer vos réglages 
sous forme de préréglage.
Dans la mesure où le transcodage nécessaire pour créer le fichier partagé se réalise en arrièreplan, vous pouvez continuer à travailler sur vos projets dans Final Cut Pro après le partage. 
(N’oubliez pas que les modifications que vous apportez à un projet après que le processus de 
transcodage a commencé ne sont pas prises en compte dans les fichiers en sortie.)
Partage d’un projet, d’un plan ou d'une plage
1 Procédez de l’une des manières suivantes:
• Sélectionnez un projet dans la bibliothèque de projets.
• Sélectionnez un plan dans le navigateur d’événements.
• Sélectionnez une plage dans un projet dans la timeline ou dans un plan situé dans le navigateur d’événements. 
2 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Partager, puis une destination dans le sous-menu.Chapitre 14 Partage de votre projet 396
• Cliquez sur le bouton Partager dans la barre d’outils, puis choisissez une destination dans le 
menu local. 
3 Dans la fenêtre qui s’affiche, procédez comme suit :
Placez le pointeur sur l’image 
pour survoler la vidéo.
Attributs du 
projet
Informations sur 
le fichier
• Placez le pointeur sur l’image pour survoler la vidéo.
• Dans la fenêtre Infos de droite, visualisez et modifiez les attributs du projet ou du plan, tels 
que le titre et la description.
Important : Par défaut, le champ de titre répertorie le nom du projet ou du plan. La modification du titre n’entraîne pas celle du nom du projet ou du plan correspondant, qui reste celui 
utilisé pour le fichier exporté.
Tous les attributs associés au projet ou au plan sont ainsi inclus dans le fichier généré en 
sortie. Vous pouvez modifier les attributs qui apparaissent dans la fenêtre Infos. Pour en savoir 
plus, consultez Modification des attributs de partage à la page 400.
• Les informations relatives au fichier à exporter sont reprises en bas de la fenêtre et mentionnent notamment la taille d’image et la fréquence d’images, les canaux audio et l’échantillonnage, le type de fichier en sortie et la taille du fichier.Chapitre 14 Partage de votre projet 397
Pour certaines destinations, vous pouvez afficher la liste des appareils capables de reproduire le fichier exporté. Pour afficher les appareils compatibles, placez le pointeur sur l’icône 
Compatibilité située dans le coin inférieur droit.
Placez le pointeur sur 
l’icône pour afficher les 
appareils compatibles.
4 Pour afficher les réglages de la destination, cliquez sur Réglages. 
Ceux-ci s’affichent dans la fenêtre homonyme. Au besoin, modifiez les réglages de la destination.
Remarque : Si vous modifiez les réglages de la destination, les modifications sont alors enregistrées comme réglages par défaut pour la destination. Pour en savoir plus, consultez Préférences 
de destinations à la page 441.
5 Cliquez sur Partager ou sur Suivant. 
Le bouton qui s’affiche s’adapte en fonction de la destination choisie. Si vous cliquez sur 
Suivant, attribuez un nom au fichier, choisissez un emplacement où l’enregistrer, puis cliquez 
sur Enregistrer.
Il vous est possible de contrôler la progression du transcodage dans la fenêtre Tâches en arrièreplan, puis continuer à travailler dans Final Cut Pro pendant le transcodage du fichier.
Une fois le transcodage terminé, le fichier résultant s’ouvre dans l’application indiquée dans 
le menu local «Ouvrir avec » de la fenêtre Réglages, est enregistré à l’emplacement choisi ou, 
si vous avez utilisé une destination web, est téléchargé sur le site web. Vous pouvez afficher et 
retrouver les projets partagés dans l’inspecteur de partage. Pour en savoir plus, consultez Accès, 
annonce et affichage de l’emplacement des projets partagés à la page 405.
Remarque : Si vous avez ajouté des marqueurs de chapitre à votre projet, leurs vignettes sont 
alors placées à l’emplacement qui convient au moment du partage sur disque (DVD et Blu-ray) et 
aux formats M4V, QuickTime et MP4 (en cas de lecture dans iTunes, QuickTime Player et sur des 
dispositifs Apple). Pour en savoir plus, consultez Gestion des marqueurs de chapitre et de leur 
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Partage des rôles sous forme de fichiers à part
Vous pouvez exporter un ou plusieurs rôles d’un projet ou d’un plan sous forme de stems. Par 
exemple, vous pouvez exporter les effets de dialogue, de musique et sonores à partir d’un projet 
sous forme de fichiers de média distincts en attribuant des rôles aux effets de dialogue, de 
musique et sonores puis en exportant ces rôles. Vous pouvez exporter des rôles sous forme soit 
d’un fichier QuickTime multipiste combiné, soit de fichiers audio ou vidéo séparés. Vous pouvez 
en outre attribuer une sortie mono, stéréo ou Surround à vos canaux audio. Pour en savoir plus, 
consultez Présentation des rôles à la page 310.
1 Procédez de l’une des manières suivantes:
• Sélectionnez un projet dans la bibliothèque de projets.
• Sélectionnez un plan dans le navigateur d’événements.
• Sélectionnez une plage dans un projet dans la timeline ou dans un plan situé dans le navigateur d’événements.
2 Choisissez Fichier > Fichier master (ou cliquez sur le bouton Partager dans la barre d’outils, puis 
choisissez Fichier master dans le menu local).
Remarque : Vous pouvez également choisir une autre destination que vous avez créée en fonction du fichier master ou de la destination Exporter le fichier. 
3 Cliquez sur le bouton Réglages, puis indiquer les réglages suivants:
• Format: Choisissez un format de masterisation (Vidéo et audio, Vidéo seulement, Audio 
seulement).
• Codec vidéo : le codec source est repris par défaut. En fonction de votre média source, il vous 
est possible de choisir un autre codec.
• Résolution : la résolution (d’après le métrage source) est fournie. En fonction de votre média 
source, il vous est possible de choisir une autre résolution.
• Formats de fichiers audio : le format source est répertorié par défaut. En fonction de votre 
média source, il vous est possible de choisir un autre format audio.
• Inclure les marqueurs de chapitre : cochez la case pour inclure les marqueurs de chapitre avec le 
ou les fichiers exportés.
• Ouvrir avec : choisissez l’opération que vous souhaitez voir s’exécuter une fois 
l’exportation terminée.
4 Dans le menu local « Rôles en tant que », choisissez les rôles à exporter.
Remarque : Les options proposées dans ce menu local s’adaptent en fonction de votre sélection 
dans les menus locaux Format et Format de fichier audio.
• Séquence QuickTime : exporte l’intégralité des rôles inclus dans le projet sous forme de 
séquence QuickTime unique.
Si vous choisissez cette option, ignorez l’étape 5.
• Rôles en tant que séquence QuickTime multipiste : exporte les rôles précisés sous forme de 
séquence QuickTime unique.
• Rôles en tant que fichiers séparés: exporte chacun des rôles vidéo et audio indiqués en tant que 
fichiers séparés.
• Rôles vidéo uniquement en tant que fichiers séparés: exporte chacun des rôles vidéo indiqués en 
tant que fichiers séparés.
• Rôles audio uniquement en tant que fichiers séparés: exporte chacun des rôles audio indiqués en 
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5 Pour spécifier les rôles à exporter, effectuez l’une des opérations suivantes:
• Pour ajouter un rôle aux fichiers à exporter: cliquez sur Ajouter un fichier vidéo ou Ajouter un 
fichier audio, puis choisissez un rôle dans le menu local.
Si vous ajoutez un rôle audio, vous pouvez également choisir le format de canaux à donner 
au rôle (Mono, Stéréo ou Surround). Pour en savoir plus, consultez Configuration des canaux 
audio à la page 176.
Si vous avez choisi « Rôles en tant que séquence QuickTime multi-pistes » dans le menu local 
« Rôles en tant que », le bouton « Ajouter un fichier vidéo » est estompé.
• Pour supprimer un rôle des fichiers à exporter: placez le pointeur sur le rôle à supprimer, puis 
cliquez sur le bouton Supprimer (–) affiché à droite du menu local.
Ces rôles seront exportés.
6 Cliquez sur Suivant, attribuez un nom au fichier, choisissez un emplacement où l’enregistrer, puis 
cliquez sur Enregistrer.
Il vous est possible de contrôler la progression du transcodage dans la fenêtre Tâches en arrièreplan, puis continuer à travailler dans Final Cut Pro pendant le transcodage du fichier.
Une fois le transcodage terminé, le fichier résultant s’ouvre dans l’application indiquée dans le 
menu local «Ouvrir avec » de la fenêtre Réglages ou est enregistré à l’emplacement choisi. Vous 
pouvez afficher et retrouver les projets partagés dans l’inspecteur de partage. Pour en savoir plus, 
consultez Accès, annonce et affichage de l’emplacement des projets partagés à la page 405.
Enregistrement d’un préréglage personnalisé
Après avoir créé une liste personnalisée de rôles à partager, vous pouvez l’enregistrer en tant que 
préréglage personnalisé.
1 Configurez vos options de partage en suivant les instructions reprises ci-dessus dans la section 
« Partage des rôles sous forme de fichiers à part ».
2 Dans le menu local « Rôles en tant que », effectuez l’une des opérations suivantes:
• Pour enregistrer un nouveau préréglage : choisissez Enregistrer sous, attribuez un nom au préré-
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• Pour enregistrer un préréglage que vous avez modifié : choisissez Enregistrer. 
• Pour enregistrer un préréglage en tant que nouveau préréglage : choisissez Enregistrer sous, attribuez un nom au préréglage, puis cliquez sur Enregistrer.
• Pour renommer un préréglage : choisissez Renommer, attribuez un nouveau nom au préréglage, 
puis cliquez sur Enregistrer.
Remarque : Le mot « modifié » apparaît à la suite des noms des préréglages personnalisés que 
vous avez modifiés.
Les préréglages personnalisés que vous créez apparaissent en bas du menu local « Rôles en 
tant que ».
Les préréglages personnalisés sont enregistrés dans le dossier /Utilisateurs/nom_utilisateur/
Séquences/Final Cut Events/Export Presets/.
Suppression d’un préréglage personnalisé
Vous pouvez supprimer les préréglages personnalisés que vous avez créés.
1 Sélectionnez un projet ou plan, cliquez sur le bouton Partager dans la barre d’outils, puis choisissez Fichier master dans le menu local.
2 Dans la fenêtre Partager, cliquez sur le bouton Réglages et, dans le menu local « Rôles en tant 
que », choisissez le préréglage personnalisé à supprimer. 
Les préréglages personnalisés sont répertoriés en bas du menu local.
Après avoir choisi un préréglage, une coche apparaît en regard de son nom.
3 Dans le menu local « Rôles en tant que », choisissez Supprimer.
Modification des attributs de partage
Les attributs de partage représentent des métadonnées de projet et de plan, inclus avec les 
fichiers exportés. Vous pouvez afficher et modifier les attributs partagés dans l’inspecteur 
de partage.
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Affichage et modification des attributs de partage pour un plan ou un projet
1 Sélectionnez un plan ou un projet.
2 Pour ouvrir l’inspecteur de partage, cliquez sur le bouton Inspecteur de la barre d’outils (illustré 
ci-dessous), puis cliquez sur le bouton Partage situé en haut de la fenêtre qui s’affiche.
3 Si les attributs de la sélection ne s’affichent pas, placez le pointeur sur Attributs, puis cliquez sur 
Afficher. 
Cliquez sur 
Afficher.
4 Saisissez le nouveau texte dans le champ d’un attribut.
Si vous saisissez un mot ou une expression ayant été défini en tant qu’attribut, ce dernier (un 
mot ou une expression dans une bulle bleue) apparaît après la fin de la saisie. 
Champs d’attributs
Modification des champs d’attribut affichés dans l’inspecteur de partage
1 Sélectionnez un plan ou un projet.
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L’inspecteur de partage contient un menu local vous permettant de personnaliser les champs 
d’attributs.
Cliquez pour 
afficher les options 
permettant la 
personnalisation des 
champs d’attributs.
3 À l’aide du menu local Attributs, effectuez l’une des opérations suivantes:
• Pour ajouter un champ d’attribut: cochez la case du nom de champ.
Les champs portant une coche s’affichent dans l’inspecteur de partage et sont exportés avec 
votre plan ou projet.
Les champs qui 
s’affichent dans 
l’inspecteur de partage 
présentent une coche.
• Pour supprimer un champ d’attribut: décochez la case du nom de champ.
• Pour n’afficher que les champs d’attributs Final Cut Pro par défaut: choisissez Afficher les champs 
par défaut. 
Choisir cette option entraîne l’affichage des seuls champs Titre, Description, Créateur et 
Mots-clés.
Important : Les champs par défaut ne peuvent pas être supprimés.
• Pour enregistrer les champs d’attributs sélectionnés comme ensemble par défaut: choisissez 
Enregistrer comme réglages par défaut.
• Pour afficher votre ensemble par défaut de champs d’attributs: choisissez Mettre à jour aux 
valeurs par défaut.
Modification automatique des attributs affichés dans un champ de l’inspecteur de partage
Vous pouvez définir les attributs qui apparaissent automatiquement dans un champ d’attribut.
1 Dans l’inspecteur de partage, choisissez « Modifier les champs de partage » dans le menu 
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2 Dans la fenêtre qui s’affiche, sélectionnez un champ d’attribut dans la liste de gauche. 
Les attributs affectés au champ sélectionné s’affichent dans le champ Format. 
Sélectionnez un champ d’attribut. Champ Format
Les options pour le champ apparaissent 
au milieu de la fenêtre.
3 Pour modifier le champ d’attribut sélectionné, effectuez l’une des opérations suivantes:
• Pour ajouter un attribut: faites glisser un attribut (un mot ou une expression dans une bulle 
bleue) du milieu de la fenêtre sur le champ Format. Vous avez également la possibilité de saisir 
le nom de l’attribut dans le champ. 
• Pour ajouter du texte : saisissez un mot ou une expression dans le champ Format situé dans la 
partie supérieure de la fenêtre.
• Pour créer un attribut de nom personnalisé : saisissez un mot ou une expression dans le champ 
Nom personnalisé en bas de la fenêtre, puis faites glisser l’attribut Nom personnalisé sur le 
champ Format.
Conseil : Dans la mesure où l’attribut de nom personnalisé apparaît dans le champ Format 
sous l’appellation « Nom personnalisé », vous pouvez l’utiliser pour des expressions ou des 
phrases longues tout en pouvant consulter facilement les autres attributs et texte dans le 
champ Format. 
• Pour supprimer un attribut ou texte : sélectionnez l’attribut ou texte et appuyez sur Supprimer. 
Lors de l’ajout et de la suppression des attributs, l’exemple (repris sous le champ Format) s’actualise d’après vos modifications.
4 Lorsque vous avez fini, cliquez sur OK. 
Exportation d’un projet par le biais de Compressor
Les destinations proposées dans Final Cut Pro offrent de nombreuses options pour l’exportation 
de projets et de plans. Si vous avez besoin de plus amples options, vous pouvez faire appel à 
Compressor, l’application professionnelle de transcodage conçue pour fonctionner directement 
avec Final Cut Pro, pour créer des réglages d’exportation hautement personnalisés. Par exemple, 
les commandes de redimensionnement et de resynchronisation de Compressor vous permettent 
de procéder à des réglages très fins de la taille d’image et de la fréquence d’images dans vos 
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Envoi d’un projet à Compressor
1 Sélectionnez un projet dans la bibliothèque de projets, un plan dans le navigateur d’événements 
ou une plage dans un projet ou plan. 
2 Choisissez Fichier > Envoyer à Compressor.
Remarque : La commande Envoyer à Compressor est estompée si Compressor n’est pas installé 
sur le même ordinateur que Final Cut Pro.
Compressor s’ouvre sur un nouveau lot contenant une tâche avec le média du projet ou du plan.
3 Configurez la tâche en ajoutant les réglages nécessaires, puis cliquez sur Soumettre.
Pour en savoir plus sur la configuration des tâches et des réglages, consultez l’. Aide Compressor 
à l'adresse http://help.apple.com/compressor.
État des projets partagés
Présentation de l’état de projets partagés
Lorsque vous publiez ou partagez votre projet par le biais de l’une des options de partage, une 
icône de partage apparaît dans la timeline et dans la bibliothèque de projets pour indiquer que 
le projet est publié.
Icône de partage
Icône de 
partage
Vous pouvez cliquer sur l’icône reprise dans la bibliothèque de projets pour ouvrir l’inspecteur de 
partage. L’inspecteur de partage affiche où et quand le projet est publié, et prévoit également un 
menu local composé de commandes complémentaires pour les options de partage prenant en 
charge ces commandes.
Cliquez sur cette flèche 
pour ouvrir le menu local 
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Si vous apportez des modifications au projet, un symbole apparaît en regard de l’icône de partage, ce qui indique que le projet a été modifié depuis son dernier partage. 
L’icône indique que le projet a 
été modifié après sa dernière 
publication.
Accès, annonce et affichage de l’emplacement des projets partagés
Vous pouvez passer par les options présentes dans l’inspecteur de partage pour ouvrir un projet 
partagé sur une destination web ou pour envoyer un courrier électronique annonçant la mise 
en ligne du projet. Il vous est également possible de localiser le fichier d’un projet partagé dans 
le Finder. 
Cliquez sur cette flèche 
pour ouvrir le menu local 
de l’élément partagé.
Ouverture de l’inspecteur de partage
m Cliquer sur l’icône de partage relative au projet, présente dans la bibliothèque de projets.
Icône de 
partage
Affichage du projet à son emplacement de partage
m Dans l’inspecteur de partage, choisissez Visiter dans le menu local de l’élément partagé.
Remarque : Tous les éléments partagés ne disposent pas d’un menu local.
Création d’un courrier électronique pour annoncer le partage d’un projet
1 Dans l’inspecteur de partage, choisissez « Recommander à un ami » dans le menu local de 
l’élément partagé.
Remarque : Tous les éléments partagés ne disposent pas d’un menu local.
2 Dans Mail, adaptez le courrier électronique généré selon vos besoins, puis cliquez sur Envoyer.
Celui-ci mentionne un lien vers le projet publié et un titre.Chapitre 14 Partage de votre projet 406
Localisation d’un projet partagé dans le Finder
Dans l’inspecteur de partage, procédez de l’une des manières suivantes:
m Si le projet a été partagé une fois et qu’un seul élément partagé s’affiche : Cliquez sur l’icône 
de loupe.
m Si le projet a été partagé plusieurs fois: cliquez sur Afficher pour visualiser les éléments partagés, 
puis sur l’icône de la loupe pour l’élément à retrouver. 
Remarque : Tous les éléments partagés ne disposent pas d’une icône représentant une loupe.
Pour en savoir plus sur les fichiers partagés, consultez Emplacement de vos fichiers de média et 
de projet à la page 407.
Suppression de projets partagés
Il se peut que vous soyez amené à supprimer un projet partagé de son site web ou autre cible 
finale. Dans certains cas, Final Cut Pro peut être en mesure de le supprimer automatiquement ; 
dans d’autres, il se peut que vous deviez le faire manuellement. Mais dans tous les cas de figure, 
le projet doit être mis à jour afin qu’il n’indique plus qu’il est partagé sur la cible.
Suppression d’un film de sa cible
1 Ouvrez l’inspecteur de partage en cliquant sur l’icône de partage du projet, présente dans la 
bibliothèque de projets.
2 Dans l’inspecteur de partage, choisissez Supprimer dans le menu local de l’élément partagé.
Cliquez sur cette flèche 
pour ouvrir le menu local 
de l’élément partagé.
Une fenêtre propose alors les options de l’élément partagé en question.
Remarque : Tous les éléments partagés ne disposent pas d’un menu local.
3 En fonction des options présentent dans la fenêtre, procédez de l’une des manières suivantes:
• Pour que Final Cut Pro supprime le projet de la destination, saisissez votre mot de passe pour 
le site web que vous avez partagé, puis cliquez sur OK.
• Supprimez le projet manuellement de la cible, puis cliquez sur Terminé.
Remarque : Pour supprimer un film de CNN iReport, vous devez contacter le site web pour 
demander la suppression du film.
L’état de publication de l’élément partagé est alors supprimé du projet.15
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Présentation de la gestion de média
De manière générale, toute tâche relative au traitement de vos fichiers de média est considé-
rée comme de la gestion de média. La gestion de média comprend les éléments présentés 
ci-dessous:
• l’importation de média depuis des caméras, des disques de stockage externe ou tout autre 
dispositif – Consultez Présentation de l’importation à la page 21.
• Le transcodage de vos fichiers de média source dans des formats, optimisés ou proxy, en 
haute qualité et pratiques à manipuler. Consultez Transcodage des fichiers de média à la 
page 415.
• la sauvegarde, la consolidation et le déplacement de projets – Consultez Avant de déplacer ou 
de copier des événements et des projets à la page 419.
• la création d’archives de caméra – Consultez Création et gestion des archives de caméra à la 
page 429.
• la reconnexion de plans à des fichiers de média – Consultez Reconnexion de plans à des 
fichiers de média à la page 410.
Certaines de ces tâches peuvent être accomplies dans Final Cut Pro, d’autres dans le Finder et 
certaines requièrent des manipulations aussi bien dans Final Cut Pro que dans le Finder.
Emplacement de vos fichiers de média et de projet
Lorsque vous créez un événement ou un projet, les dossiers de ce nouvel élément sont placés 
dans l’un des deux emplacements détaillés ci-dessous.
• Si le nouvel événement ou le nouveau projet se trouve sur votre système : les dossiers se trouvent 
dans le dossier Séquences de votre répertoire de départ (/Utilisateurs/nom d’utilisateur/
Séquences/). Il s’agit de l’emplacement par défaut pour vos fichiers Final Cut Pro.
• Si le nouvel événement ou le nouveau projet est situé sur un périphérique de stockage externe 
connecté : les dossiers sont placés au niveau principal, la racine, de votre dispositif.
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• Si le nouvel événement ou le nouveau projet est enregistré sur un périphérique de stockage 
connecté à un réseau local : les dossiers peuvent se trouver sur n’importe quel dossier que vous 
avez ajouté à partir d’un réseau de stockage SAN.
Lorsque vous créez un événement sur votre système local, un dossier est créé pour cet 
événement :
/Utilisateurs/nom d’utilisateur/Séquences/Final Cut Events/nom de l’événement/
Le dossier [nom de l’événement] peut contenir un ou plusieurs des éléments présentés ci-dessous. Le contenu de ces dossiers varie en fonction des options sélectionnées lors de l’importation 
ou dans les préférences Importation. Ces fichiers sont utilisés et gérés par Final Cut Pro et ne 
doivent par conséquent pas êtres déplacés, modifiés ou supprimés.
• Fichier d’événement: Les fichiers d’événements de Final Cut Pro portent le nom de 
CurrentVersion.fcpevent.
• Fichiers d’analyse : ce dossier contient les fichiers d’analyse associés aux fichiers de média.
• Média d’origine : ce dossier contient les fichiers originaux importés depuis votre caméra 
ou votre disque dur ou les fichiers alias renvoyant vers les fichiers originaux situés à un 
autre emplacement.
• Fichiers de rendu : ce dossier contient les fichiers de rendu associés aux fichiers de média.
• Média transcodé : si vous choisissez de créer des médias optimisés ou proxy, les fichiers transcodés créés sont placés dans ce dossier.
• Versions précédentes: si vous mettez des événements à jour pour les ouvrir avec une nouvelle 
version de l’application, Final Cut Pro sauvegarde d’abord des copies des événements originaux dans ce dossier.
• Copies de sauvegarde : ce dossier contient une copie de sauvegarde de chaque événement. 
Il s’agit uniquement d’une copie de CurrentVersion.fcpevent (le fichier d’événement) et non 
des fichiers de média source associés. Final Cut Pro met la copie de sauvegarde à jour toutes 
les 15 minutes (s’il détecte un changement dans l’événement). Cette copie de sauvegarde est 
automatiquement exploitable par Final Cut Pro en cas de problème, bien qu’improbable, à 
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De même, lorsque vous créez un projet Final Cut Pro, un dossier est créé pour ce projet :
/Utilisateurs/nom d’utilisateur/Séquences/Final Cut Projects/nom du projet/
Le dossier [nom du projet] contient les éléments détaillés ci-après. Ces fichiers sont utilisés et 
gérés par Final Cut Pro et ne doivent par conséquent pas êtres déplacés, modifiés ou supprimés.
• Fichier de projet: les fichiers de projet Final Cut Pro portent le nom de CurrentVersion.fcpproject.
• Fichiers de rendu : ce dossier contient les fichiers de rendu associés au projet.
• Versions précédentes: si vous mettez des projets à jour pour les ouvrir avec une nouvelle version de l’application, Final Cut Pro sauvegarde d’abord des copies des projets originaux dans 
ce dossier.
• Copies de sauvegarde : ce dossier contient une copie de sauvegarde de chaque projet. Il s’agit 
uniquement d’une copie de CurrentVersion.fcpproject (le fichier du projet) et non de fichiers 
de média quelconques. Final Cut Pro met la copie de sauvegarde à jour toutes les 15 minutes 
(s’il détecte un changement dans le projet). Cette copie de sauvegarde est automatiquement 
exploitable par Final Cut Pro en cas de problème, bien qu’improbable, à l’ouverture du projet.
• Éléments partagés: ce dossier contient les fichiers du projet.
Conseil : Pour retrouver rapidement le fichier de média source d’un plan, sélectionnez-le puis 
choisissez Fichier > Afficher dans le Finder (ou appuyez sur Commande + Maj + R).
Gestion de vos fichiers de média
Affichage des informations relatives à un plan
L’inspecteur d’informations fournit un résumé des informations relatives à un plan. Vous pouvez 
par conséquent y trouver des informations relatives à l’état du fichier de média d’un plan, notamment l’emplacement du fichier, ses représentations du média disponible, l’événement dans lequel 
le plan est situé et celui auquel il fait référence.Chapitre 15 Gestion des fichiers de média 410
Affichage des informations relatives à un plan
1 Sélectionnez un plan dans le navigateur d’événements ou dans la timeline.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur prévu sur la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui 
s’affiche.
3 Choisissez « Afficher l’état du fichier » dans le menu local Action situé dans la partie infé-
rieure de l’inspecteur d’informations.
Reconnexion de plans à des fichiers de média
Dans Final Cut Pro, les plans représentent votre média mais ne sont pas des fichiers de média 
en tant que tels. Final Cut Pro effectue automatiquement le suivi des liens entre les plans et les 
fichiers de média. Il se présente cependant des cas où il est nécessaire de reconnecter manuellement les plans aux fichiers de média.
Des fichiers de média modifiés ou recréés en dehors de Final Cut Pro représentent un cas courant. C’est le cas par exemple si vous transférez des fichiers à étalonner, que vous recevez ensuite 
une nouvelle version de ces fichiers, puis que vous devez reconnecter les plans dans votre évé-
nement ou votre projet à ces nouvelles versions.
La reconnexion manuelle peut aussi s’avérer nécessaire en cas de fichiers de média manquants. 
Par exemple, si vous déplacez ou renommez des fichiers dans le Finder, ou si vous déplacez 
un événement ou un projet, vous devez reconnecter les plans de l’événement ou du projet 
(représentés sous forme de cadres rouges dotés d’un triangle jaune évoquant un signal d’alerte) 
aux fichiers.
Dans un cas comme dans l’autre, la reconnexion manuelle permet de pointer les plans dans 
Final Cut Pro vers les bons fichiers sur votre disque dur. Les métadonnées dans les plans reconnectés sont conservées.
Les fichiers ainsi reconnectés peuvent avoir une résolution et un codec différents des fichiers originaux, mais doivent avoir un type de média identique. (En d’autres termes, vous ne pouvez pas 
reconnecter un plan vidéo à un fichier audio.) Les fichiers reconnectés doivent également pré-
senter la même fréquence d’images et des canaux audio semblables que les fichiers originaux.
Enfin, les nouveaux fichiers (reconnectés) peuvent en outre correspondre à des versions des 
fichiers originaux auxquels un trim a été appliqué, mais ils doivent alors avoir une durée suffisante de sorte à couvrir l’intégralité des plans se référant aux fichiers sous-jacents.
Dans la mesure où la reconnexion des plans d’événements et des plans de projet se caractérise 
par des effets différents sur vos événements et vos projets, ceux-ci sont abordés séparément 
ci-dessous.Chapitre 15 Gestion des fichiers de média 411
Reconnexion de plans d’événements à des fichiers de média
Si vous reconnectez des plans d’événements à des fichiers de média sur votre disque dur, tous 
les plans correspondants (y compris ceux inclus dans d’autres projets ou événements) sont 
mis à jour pour assurer la connexion avec les nouveaux fichiers de média. En d’autres termes, si 
vous avez utilisé un plan d’événement dans plusieurs projets (ou événements), chacun de ces 
projets et événements est reconnecté au nouveau fichier de média. Si les anciens fichiers se 
trouvent dans le dossier Média d’origine, ils sont alors placés dans la Corbeille. Cette opération 
est irréversible. 
1 Dans le navigateur d’événements, sélectionnez les plans à reconnecter ou sélectionnez un évé-
nement entier dans la bibliothèque d’événements.
2 Choisissez Fichier > Relier les fichiers d’événement.
La fenêtre Relier les fichiers s’affiche alors. Par défaut, cette fenêtre ne reprend que les plans ou 
les événements manquants.
3 Pour recenser tous les éléments de la sélection, sélectionnez Tous.
4 Procédez de l’une des manières suivantes:
• Pour retrouver tous les fichiers correspondants: cliquez sur Tout localiser. 
• Pour localiser certains fichiers répondant aux critères: sélectionnez les éléments dans la liste, puis 
cliquez sur Localiser. 
5 Dans la fenêtre qui s’affiche, accédez à l’un des fichiers à reconnecter ou au dossier les contenant.Chapitre 15 Gestion des fichiers de média 412
Le texte repris en bas de la fenêtre indique le nombre d’instances trouvées dans votre liste originale susceptibles de correspondre aux éléments (en s’appuyant uniquement sur le nom des 
fichiers).
Texte indiquant le nombre de 
correspondances trouvées.
Remarque : Final Cut Pro identifie les occurrences en fonction de leur proximité dans la structure 
des répertoires et de leur nom de fichier. Par exemple, si vos fichiers originaux se trouvent dans 
deux dossiers adjacents, Final Cut Pro recherche dans les dossiers adjacents au fichier choisi et 
reconnecte tous les fichiers correspondants dans le chemin d’accès relatif. Si vos fichiers originaux 
s’intitulent « Fichier1 », « Fichier2 », « Fichier3 », etc., et que vous avez choisi de les reconnecter à 
un fichier appelé « Fichier1_A », Final Cut Pro recherche alors les fichiers nommés « Fichier2_A », 
« Fichier3_A », etc., pour les reconnecter aux éléments restants mentionnés dans votre liste.
6 Cliquez sur Sélectionner.
Final Cut Pro analyse les fichiers pour confirmer que tous les attributs (en plus du nom de fichier) 
correspondent à des éléments intégrant la sélection d’origine. Les résultats de l’analyse sont illustrés ci-dessous dans la liste de fichiers originaux, par exemple, « 3 sur 3 fichiers trouvés ». 
7 Cliquez sur le triangle d’affichage en regard des résultats de l’analyse pour afficher la liste des 
fichiers anciens (repris à gauche) et les nouveaux fichiers correspondants (mentionnés à droite).
Si un fichier n’est pas vraiment concordant, sélectionnez-le dans la liste et appuyez sur Supprimer. 
L’élément est alors replacé dans la liste d’origine en haut de la fenêtre Relier les fichiers.Chapitre 15 Gestion des fichiers de média 413
Les éléments sans autre résultat sont conservés dans la liste d’origine supérieure. Vous pouvez 
poursuivre et en rechercher d’autres en les sélectionnant et en répétant les étapes 4 à 6.
8 Si vous voulez dupliquer les fichiers de média correspondants pour les placer dans le dossier 
Final Cut Events (Événements Final Cut) sur votre ordinateur, cochez la case « Copier les fichiers 
dans le dossier Final Cut Events ».
9 Pour connecter les plans d’événements aux nouveaux fichiers de média, cliquez sur Relier 
les fichiers.
Tous les plans correspondants (y compris ceux inclus dans d’autres projets ou événements) sont 
mis à jour pour assurer la connexion avec les nouveaux fichiers de média.
Reconnexion de plans de projet à des fichiers de média
Contrairement à la reconnexion de plans d’événements, la reconnexion des plans de projet 
à des fichiers de média sur votre disque dur se limite à la mise à jour des plans dans le projet 
sélectionné. Les nouveaux plans sont ajoutés à l’événement par défaut du projet en cours. Cette 
opération est irréversible.
1 Dans la timeline, sélectionnez les plans à reconnecter ou un projet dans la bibliothèque 
de projets.
2 Choisissez Fichier > Relier les fichiers de projet.
La fenêtre Relier les fichiers s’affiche alors. Par défaut, cette fenêtre ne reprend que les 
plans manquants.
3 Pour recenser tous les éléments de la sélection, sélectionnez Tous.
4 Procédez de l’une des manières suivantes:
• Pour retrouver tous les fichiers correspondants: cliquez sur Tout localiser. 
• Pour localiser certains fichiers répondant aux critères: sélectionnez les éléments dans la liste, puis 
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5 Dans la fenêtre qui s’affiche, accédez à l’un des fichiers à reconnecter ou au dossier les contenant.
Le texte repris en bas de la fenêtre indique le nombre d’instances trouvées dans votre liste originale susceptibles de correspondre aux éléments (en s’appuyant uniquement sur le nom des 
fichiers).
Texte indiquant le nombre de 
correspondances trouvées.
Remarque : Final Cut Pro identifie les occurrences en fonction de leur proximité dans la structure des répertoires et de leur nom de fichier. Par exemple, si vos fichiers originaux se trouvent 
dans deux dossiers adjacents, Final Cut Pro recherche dans les dossiers adjacents au fichier 
choisi et reconnecte tous les fichiers correspondants dans le chemin d’accès relatif. Si vos fichiers 
originaux s’intitulent « Fichier1 », « Fichier2 », « Fichier3 », etc., et que vous avez choisi de les 
reconnecter à un fichier appelé « Fichier1_A », Final Cut Pro recherche alors les fichiers nommés 
« Fichier2_A », « Fichier3_A », etc., pour les reconnecter aux éléments restants mentionnés dans 
votre liste.
6 Cliquez sur Sélectionner.
Final Cut Pro analyse les fichiers pour confirmer que tous les attributs (en plus du nom de fichier) 
correspondent à des éléments intégrant la sélection d’origine. Les résultats de l’analyse sont illustrés ci-dessous dans la liste de fichiers originaux, par exemple, « 4 sur 4 fichiers trouvés ».
7 Cliquez sur le triangle d’affichage en regard des résultats de l’analyse pour afficher la liste des 
fichiers anciens (repris à gauche) et les nouveaux fichiers correspondants (mentionnés à droite).Chapitre 15 Gestion des fichiers de média 415
Si un fichier n’est pas vraiment concordant, sélectionnez-le dans la liste et appuyez sur 
Supprimer. L’élément est alors replacé dans la liste d’origine en haut de la fenêtre Relier 
les fichiers.
Les éléments sans autre résultat sont conservés dans la liste d’origine supérieure. Vous pouvez 
poursuivre et en rechercher d’autres en les sélectionnant et en répétant les étapes 4 à 6.
8 Pour connecter les plans de projet aux nouveaux fichiers de média, cliquez sur Relier les fichiers.
Seuls les plans inclus dans le projet en cours sont mis à jour et reconnectés aux nouveaux fichiers 
de média. Les nouveaux plans sont ajoutés à l’événement par défaut du projet. Tous les autres 
événements et projets sont conservés tels quels.
Transcodage des fichiers de média
Final Cut Pro peut reproduire de nombreux formats de médias. Consultez Formats de média pris 
en charge à la page 45 pour en retrouver la liste complète. Final Cut Pro fournit aussi des options 
pour le transcodage de votre média en le convertissant dans un autre format ou en modifiant 
ses réglages.
• Créer un média optimisé : cette option transcode la vidéo au format de codec Apple ProRes 422, 
lequel assure de meilleures performances lors du montage, des temps de rendu réduits et une 
qualité colorimétrique supérieure lors du compositing. Si le format original de la caméra peut 
être monté en offrant de bons résultats, cette option est estompée.
• Créer un média proxy : cette option entraîne la création de fichiers proxy vidéo et d’images 
fixes. vidéo transcodée au format du codec Apple ProRes 422 (Proxy), qui offre des fichiers de 
haute qualité, utiles pour le montage déconnecté en respectant la taille, la fréquence et la proportion d’image originales. Final Cut Pro crée des versions proxy (dans la moitié de la résolution) de qualité moyenne pour améliorer les performances lors du montage. Les fichiers vidéo 
proxy occupent sensiblement moins d’espace disque, vous offrant souvent la possibilité de 
travailler sur un ordinateur portable même si celui-ci dispose d’une mémoire et de prestations 
inférieures à celles d’un ordinateur de bureau. Les images fixes sont transcodées en fichiers 
JPEG (si le fichier original ne contient pas d’informations de canal alpha) ou PNG (dans le cas 
contraire). Les fichiers proxy d’images fixes assurent un traitement et un rendu plus rapides 
lorsque l’image d’origine s’avère volumineuse.
Remarque : Pour de meilleures performances d’importation et de lecture, Final Cut Pro transcode automatiquement tous les fichiers audio MP3 en fichiers audio WAV. Lors du transcodage 
de fichiers, Final Cut Pro conserve toujours le média original en vue de son utilisation ulté-
rieure. Pour en savoir plus sur l’emplacement des fichiers de média originaux, de média proxy 
et de média transcodés, consultez Emplacement de vos fichiers de média et de projet à la 
page 407.
Vous pouvez également créer des médias optimisés et proxy lors de la procédure d’importation 
ou une fois le média importé à l’aide du navigateur d’événements. Il vous est aussi possible de 
créer un fichier proxy pour un plan à l’aide de l’inspecteur d’informations. Une fois le transcodage terminé, les fichiers sont enregistrés dans le dossier de l’événement approprié. Consultez 
Emplacement de vos fichiers de média et de projet à la page 407 pour en savoir plus.
Le réglage de lecture sélectionné dans les préférences Montage de Final Cut Pro définit si 
Final Cut Pro utilise un média proxy, votre média original ou un média optimisé lors de la lecture. 
Consultez Modification du nom et des propriétés d’un projet à la page 89 pour en savoir plus.Chapitre 15 Gestion des fichiers de média 416
Transcodage de fichiers de média lors de l’importation
Lors de l’importation, Final Cut Pro crée un fichier alias qui redirige sur l’emplacement original du 
fichier de média ou une copie du fichier de média original. Une fois les fichiers importés, le transcodage, l’optimisation et l’analyse s’exécutent à l’arrière-plan.
1 Procédez de l’une des manières suivantes:
• Pour importer un fichier à partir d’un enregistrement à système de fichier compatible ou d’un périphérique de stockage, ou à partir de votre disque dur: branchez le dispositif sur votre ordinateur, 
allumez-le, choisissez Fichier > Importer > Média (ou appuyez sur Commande + I), accédez au 
média à importer et sélectionnez-le, puis cliquez sur Importer.
• Pour importer un fichier à partir d’un caméscope à bande : connectez l’appareil à votre ordinateur, allumez-le et réglez-le sur le mode VTR ou VCR. Choisissez ensuite Fichier > Importer > 
Média, puis cliquez sur Importer.
• Pour importer des fichiers à partir d’une archive : Choisissez Fichier > Importer > Média. 
Sélectionnez ensuite une archive de caméra dans la liste de gauche, cliquez sur Ouvrir une 
archive et localisez les fichiers que vous souhaitez importer. Cliquez enfin sur Importer.
2 Dans la fenêtre qui apparaît, choisissez comment vous voulez organiser les médias importés dans 
votre bibliothèque d’événements:
• Pour ajouter les médias importés à un événement existant: sélectionnez « Ajouter à l’événement 
existant » et choisissez celui-ci dans le menu local.
• Pour créer un événement: sélectionnez « Créer un nouvel événement » et saisissez un nom 
(par exemple, « Mariage de Pierre et Sandra ») dans le champ de texte. Utilisez le menu local 
« Enregistrer dans » pour choisir le disque sur lequel vous voulez stocker l’événement.
Pour en savoir plus sur les événements, consultez Présentation des événements et des plans à la 
page 55.
3 Sélectionnez une ou plusieurs options de transcodage.
Final Cut Pro transcode les fichiers en arrière-plan, une fois l’importation terminée.
4 Cliquez sur Importer.
L’importation peut prendre quelques minutes, selon les options que vous avez choisies à 
l’étape 3. Vous pouvez voir l’état de tous les processus en cours en arrière-plan dans la fenêtre 
Tâches d’arrière-plan.
Transcodage des plans après l’importation
1 Cliquez sur un ou plusieurs plans dans le navigateur d’événements tout en maintenant la touche 
Contrôle enfoncée et choisissez Transcoder le média dans le menu contextuel.
2 Dans la fenêtre qui s’affiche, cochez la case « Créer un média optimisé », la case « Créer un média 
proxy » ou les deux, puis cliquez sur OK.
Remarque : Si le format original de la caméra peut être monté en offrant de bons résultats, l’option « Créer un média optimisé » apparaît alors estompée.
La procédure de transcodage peut prendre un certain temps, en fonction des options que vous 
avez choisies. Vous pouvez voir l’état de tous les processus en cours en arrière-plan dans la 
fenêtre Tâches d’arrière-plan.
Remarque : Les fichiers audio MP3 issus de projets créés avec des versions de Final Cut Pro 
antérieures à 10.0.4 peuvent être transcodés manuellement en fichiers audio WAV à l’aide de 
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Transcodage automatique des fichiers de média lors de leur glissement dans Final Cut Pro
Lorsque vous faites glisser un média depuis le Finder sur un événement ou sur la timeline dans 
Final Cut Pro, celui-ci est automatiquement organisé, transcodé et analysé en fonctions des 
réglages d’importation définis dans les préférences de Final Cut Pro.
1 Pour configurer les options relatives à l’analyse par Final Cut Pro :
a Choisissez Final Cut Pro > Préférences.
b Dans la fenêtre Préférences qui s’affiche, cliquez sur Importer.
c Sélectionnez la ou les options d’analyse vidéo et audio que vous souhaitez appliquer à 
votre média.
d Lorsque vous avez terminé, fermez la fenêtre Préférences.
2 Pour importer un ou plusieurs fichiers, sélectionnez un fichier (ou cliquez sur plusieurs fichiers en 
maintenant la touche Commande enfoncée) dans le Finder et faites-le glisser sur un événement 
ou sur la timeline.
Génération d’un fichier proxy depuis l’inspecteur d’informations
Les fichiers proxy occupent sensiblement moins d’espace disque. Dans certains cas, l’utilisation 
de fichiers proxy peut vous permettre de travailler sur un ordinateur portable, même si celui-ci 
possède une mémoire et une puissance de calcul moindres qu’un ordinateur de bureau. Vous 
pouvez vérifier si vous possédez un fichier proxy pour un plan en affichant les informations relatives au plan dans l’inspecteur d’informations. Si le fichier en question ne présente aucun fichier 
proxy dans l’inspecteur d’informations, un triangle rouge s’affiche.
Si aucun proxy n’a été créé 
pour un plan, un triangle rouge 
s’affiche.
Vous pouvez créer un fichier proxy pour un plan en procédant comme suit.
1 Sélectionnez un plan dans le navigateur d’événements.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur de la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui s’affiche.
3 Sélectionnez « Afficher l’état du fichier » dans le menu local Action .Chapitre 15 Gestion des fichiers de média 418
4 Cliquez sur le bouton Générer un proxy dans la section « Représentations du média disponible » 
de la zone d’état du fichier.
Le fichier proxy est créé et un cercle vert apparaît en regard de l’élément proxy dans la section « Représentations du média disponible » pour indiquer que le fichier proxy du plan 
est disponible.
Affichage des tâches d’arrière-plan
Dans Final Cut Pro, de nombreuses tâches s’exécutent à l’arrière-plan.
• Importation
• Transcodage
• Optimisation et analyse vidéo et audio
• Rendu
• Partage
Final Cut Pro gère automatiquement les tâches d’arrière-plan. Vous n’avez donc rien à faire pour 
les lancer ou les interrompre. Si vous souhaitez afficher la progression des procédures exécutées 
en arrière-plan, ouvrez la fenêtre Tâches d’arrière-plan. Les tâches en cours d’exécution et leur 
pourcentage d’exécution s’affichent dans la fenêtre.
Important : Si vous utilisez activement Final Cut Pro et que des tâches sont en cours d’exécution en arrière-plan, celles-ci s’interrompent. Les tâches reprennent lorsque vous n’utilisez pas 
Final Cut Pro.
Affichage des tâches en cours d’exécution en arrière-plan
1 Procédez de l’une des manières suivantes:
• Choisissez Fenêtre > Tâches d’arrière-plan (ou appuyez sur les touches Commande + 9).
• Dans la barre d’outils, cliquez sur le bouton Tâches en arrière-plan.
2 Pour afficher les tâches en cours d’exécution dans chaque section, cliquez sur le triangle 
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Mise en pause ou reprise d’une tâche dans la fenêtre Tâches en arrière-plan
m Cliquez sur le bouton Pause ou Reprendre .
Annulation d’une tâche dans la fenêtre Tâches en arrière-plan
m Cliquez sur le bouton Annuler .
Suppression des fichiers de rendu pour libérer de l’espace disque
Les fichiers de rendu du projet et des plans sont conservés dans les dossiers Final Cut Events 
et Final Cut Projects. Avec le temps, ces fichiers peuvent devenir volumineux et occuper de 
l’espace disque. Si vous souhaitez libérer de l’espace disque, vous pouvez supprimer les fichiers 
de rendu inutilisés ou supprimer tous les fichiers de rendu d’un plan composé ou d’un projet 
Final Cut Pro particulier.
Suppression des fichiers de rendu du projet
1 Sélectionnez un projet dans la bibliothèque de projets.
2 Choisissez Fichier > Supprimer les fichiers de rendu du projet.
3 Dans la fenêtre qui s’affiche, choisissez de supprimer « Fichiers de rendu inutilisés seulement » ou 
« Tous les fichiers de rendu », puis cliquez sur OK.
Suppression des fichiers de rendu d’un événement
1 Sélectionnez un événement dans le navigateur d’événements.
2 Choisissez Fichier > Supprimer les fichiers de rendu d’événement.
3 Dans la fenêtre qui s’affiche, choisissez de supprimer « Fichiers de rendu inutilisés seulement » ou 
« Tous les fichiers de rendu », puis cliquez sur OK.
Gestion de vos fichiers d’événements et de projets
Avant de déplacer ou de copier des événements et des projets
Si vous souhaitez réaliser le montage d’un projet sur un autre ordinateur ou sauvegarder un 
projet ou des événements sur un périphérique de stockage externe, vous pouvez les déplacer ou 
les copier. Avant de déplacer ou de copier un projet, il est recommandé de consolider ses médias 
et de les sauvegarder.
Par défaut, les fichiers de média importés dans Final Cut Pro restent à leur emplacement original. 
Lorsque vous importez des médias dans Final Cut Pro vous avez la possibilité de cocher la case 
« Copier les fichiers dans le dossier Final Cut Events » ce qui permet de dupliquer les fichiers 
de média source sur votre disque dur. La création de ces copies (à utiliser exclusivement dans 
Final Cut Pro) permet d’éviter que les fichiers soient déplacés par inadvertance et deviennent 
indisponibles dans Final Cut Pro.
Si un fichier utilisé par Final Cut Pro est déplacé, Final Cut Prosignale le plan avec une icône de 
fichier manquant. Si vous considérez qu’il existe une possibilité que les fichiers de média soient 
déplacés ou supprimés, il est recommandé de créer une copie du média.Chapitre 15 Gestion des fichiers de média 420
Remarque : Si vous importez des fichiers alors que la case « Copier les fichiers dans le dossier Final 
Cut Events » est décochée, Final Cut Pro crée alors des fichiers de référence (alias de fichiers) pointant simplement sur les fichiers de média source, sans copier ces derniers. Au moment où vous 
sauvegardez ou copiez des événements et des projets utilisant ces fichiers, Final Cut Pro copie uniquement les fichiers de référence (et non les fichiers de média source). Si après avoir sauvegardé 
votre projet ou événement, vous souhaitez remplacer les fichiers de référence par les fichiers de 
média source à proprement parler, sélectionnez les événements, puis choisissez Fichier > Organiser 
les fichiers d’événements.
Consolidation des fichiers de média d’un projet
Lors de la création d’un projet dans Final Cut Pro, vous pouvez utiliser des médias situés à différents 
endroits, y compris votre ordinateur local et des périphériques de stockage externe. Si les médias 
utilisés dans le projet sont situés sur différents disques durs, vous pouvez consolider tous les médias 
du projet sur le disque dur où se trouve le projet.
Regroupement à un seul emplacement des plans d’un projet
1 Localisez le projet que vous souhaitez consolider dans la bibliothèque de projets.
2 Cliquez sur le projet tout en maintenant la touche Contrôle enfoncée, puis choisissez « Consolider 
les médias du projet » dans le menu contextuel.
Si une fenêtre s’affiche déclarant qu’il n’y a aucun élément à consolider, cela signifie que tous vos 
fichiers de média sont déjà consolidés et stockés sur un disque.
3 Sélectionnez une option pour définir le déroulement de la consolidation.
• Copier les événements référencés: duplique les événements référencés (et tous les plans contenus 
dans ceux-ci) dans l’emplacement de votre projet. Cette option s’avère utile si vous utilisez le 
même média dans plusieurs projets ou si vous n’avez pas terminé l’ajout de plans de l’événement à votre projet.
• Déplacer les événements référencés: déplace tous les événements référencés sur l’emplacement de 
votre projet. Si d’autres projets utilisent les plans de l’événement en cours de consolidation, ces 
projets n’ont alors pas accès à l’événement. Cette option peut s’avérer utile si les plans de l’évé-
nement sont utilisés uniquement dans le projet en cours de consolidation.
• Copier seulement les plans utilisés: duplique uniquement les fichiers de média utilisés dans le 
projet. Cette option ne concerne que les médias utilisés dans le projet (et non tous les plans des 
événements référencés par le projet). Elle permet de conserver plus d’espace disque.
• Champ «Nouveau nom de l’événement»: si vous choisissez « Copier seulement les plans utilisés », 
vous pouvez créer un événement destiné à héberger le média consolidé. Si vous ne spécifiez pas 
de nom pour le nouvel événement, le nom du projet lui est attribué.Chapitre 15 Gestion des fichiers de média 421
4 Cliquez sur OK.
Final Cut Pro consolide les médias à l’aide de la méthode sélectionnée. Le ou les événements 
apparaissent sur le même disque dur que le projet.
Vous pouvez aussi faire appel à la commande «Organiser les fichiers d’événements » pour copier 
tous les fichiers de média externes qu’un événement utilise dans son dossier d’événement. Pour 
en savoir plus, consultez Organisation des fichiers lors de l’importation à la page 41.
Sauvegarde des projets, des événements et de votre bibliothèque de projets
La sauvegarde de vos projets, de votre bibliothèque de projets et de vos événements représente 
une étape essentielle du flux de production. Certaines intervenants exécutent des sauvegardes 
quotidiennes ou hebdomadaires, d’autres lorsqu’un projet est terminé. Pour protéger votre 
média, il est recommandé de sauvegarder sur un périphérique de stockage ou une partition différente de celle sur laquelle vous stockez vos fichiers de média utilisés avec Final Cut Pro.
Remarque : Final Cut Pro conserve une seule copie de sauvegarde de chaque événement et 
projet. Il s’agit uniquement des copies de l’événement en cours et des fichiers de projet et non 
des fichiers de média source associés. Final Cut Pro met les copies de sauvegarde à jour toutes 
les 15 minutes, s’il détecte un changement dans un événement ou un projet. Pour en savoir plus, 
consultez Emplacement de vos fichiers de média et de projet à la page 407.
Sauvegarde de votre projet dans Final Cut Pro
1 Connectez un périphérique de stockage externe disposant d’assez d’espace pour contenir votre 
projet et vos fichiers de média et vérifiez qu’il apparaît dans le Finder.
2 Cliquez sur votre projet dans la bibliothèque de projets tout en maintenant la touche Contrôle 
enfoncée, puis choisissez Dupliquer le projet dans le menu contextuel.
3 Dans la fenêtre qui s’affiche, attribuez un nom au nouveau projet (dupliqué), puis choisissez votre 
périphérique de stockage externe dans le menu local Emplacement.
4 Sélectionnez une option pour indiquer ce qui doit être dupliqué :
• Dupliquer le projet: duplique les fichiers spécifiques du projet que vous avez sélectionnés. 
Cette option est utile, par exemple, si vous utilisez les mêmes plans dans plusieurs projets et 
que vous pensez sauvegarder vos événements séparément (par exemple dans votre copie 
de sauvegarde de l’ensemble de votre bibliothèque de projets ou de vos événements). Cette 
option ne crée pas de copie de média d’événement.
• Dupliquer le projet et les événements référencés: duplique le projet et tout événement auquel 
celui-ci se réfère. Cette option comprend touts les médias contenus dans les événements 
référencés. Cette option est particulièrement utile si vous souhaitez conserver les médias non 
utilisés en vue de leur utilisation ultérieure.
• Dupliquer le projet et les plans utilisés: copie le projet ainsi que les plans utilisés dans le projet. 
Lorsque vous sélectionnez cette option, il vous est possible de choisir entre copier tous les 
plans et leur média ou copier seulement les plans multicam et composés sans les médias 
associés. La première méthode crée une copie de sauvegarde de votre projet avec l’intégralité 
de son média. La deuxième méthode entraîne la sauvegarde du projet et crée des copies de 
travail indépendantes des plans multicam et composés qui ne changent pas si vous mettez les 
copies d’origine à jour dans votre projet.
• Tous les plans utilisés: duplique le projet et copie dans un nouvel événement tous les plans et 
le média exploité dans le projet. Lorsque vous sélectionnez cette option, vous devez attribuer 
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En sélectionnant cette option, vous dupliquez l'intégralité du fichier multimédia original pour 
tout plan utilisé dans le projet, pas uniquement la portion affichée dans la timeline. Si les 
fichiers utilisés dans le projet ont été importés en tant que fichiers de référence (alias pointant 
vers des fichiers multimédias conservés hors du dossier d'événements de Final Cut), les fichiers 
de référence sont copiés, mais pas les fichiers multimédias originaux.
• Plans multicam et composés uniquement: crée une copie du projet et les plans parents nécessaires aux plans multicam ou composés intégrant le projet. En d’autres termes, les copies de 
sauvegarde des plans multicam et des plans composés ne sont pas liées aux copies parentes 
d’origine et ne sont par conséquent pas mis à jour lorsque les originaux parents sont modifiés. 
Cette option vous permet d’enregistrer une copie de travail d’un projet et d’éviter les modifications accidentelles apportées aux plans multicam ou composés dans cette copie. Cette 
option ne duplique pas le média et génère par conséquent un ensemble de fichiers de sauvegarde plus compact économisant l’espace de stockage. Vous pouvez fournir un nom au nouvel 
événement destiné à héberger les plans multicam ou composés, ou choisir un événement 
existant à partir du menu local Événement. Pour en savoir plus sur les plans multicam et composés, consultez Présentation des plans composés à la page 266 et Présentation du montage 
multicam à la page 320.
Cette option n’est disponible que si votre projet contient des plans multicam ou composés.
5 Si vous souhaitez inclure les fichiers de rendu (pour que Final Cut Pro n’ait pas à en créer de nouveaux), cochez la case « Inclure les fichiers de rendu ».
6 Cliquez sur OK.
Final Cut Pro duplique le projet en s’appuyant sur l’option indiquée. Le projet voit son 
nom complété d’un chiffre incrémenté (par exemple « film de François1 »), puis s’affiche à 
l’emplacement indiqué.
Dans la plupart des cas, visionner vos événements et vos projets de sauvegarde revient simplement à connecter votre périphérique de stockage à Final Cut Pro et à localiser la copie de sauvegarde de votre projet ou de votre événement dans la bibliothèque de projets. Pour en savoir plus 
sur la localisation ou l’affichage de votre projet, consultez Problèmes courants relatifs à la gestion 
des médias à la page 434.Chapitre 15 Gestion des fichiers de média 423
Sauvegarde de votre bibliothèque de projets et de vos événements à l’aide du Finder
Pour créer une seule copie de sauvegarde de votre bibliothèque de projets et de vos événements, vous pouvez copier les dossiers Final Cut Projects et Final Cut Events sur un périphérique 
de stockage externe.
Si vous réalisez une copie de sauvegarde progressive, créez une structure de dossier qui vous 
permette de parcourir facilement vos dossiers de sauvegarde. Vous pouvez, par exemple, étiqueter les dossiers selon la date de la copie de sauvegarde.
Important : Pour éviter des problèmes, il est primordial que vous placiez les fichiers de sauvegarde dans un dossier, que vous pouvez appeler par exemple « Sauvegardes 2012 Final Cut Pro », 
qui ne se trouve pas à la racine de votre périphérique de stockage externe. 
1 Dans le Finder, accédez et sélectionnez vos dossiers Final Cut Projects et Final Cut Events.
Votre dossier Séquences constitue l’emplacement par défaut pour tous les fichiers de projet et 
d’événement :
/Utilisateurs/nom d’utilisateur/Séquences/
Important : Si un projet ou un événement a été déplacé après sa création, il ne se trouve plus à 
son emplacement par défaut.
2 Faites glisser les dossiers Final Cut Projects et Final Cut Events sur votre périphérique de 
stockage externe.
Les dossiers sont copiés sur votre périphérique de stockage externe.
Pour restaurer les événements et les projets que vous avez sauvegardés par le biais du Finder, 
copiez-les à leur emplacement d’origine dans les dossiers Final Cut Projects et Final Cut Events.
Remarque : Lorsque vous importez des médias dans Final Cut Pro, vous avez la possibilité de 
cocher la case « Copier les fichiers dans le dossier Final Cut Events » ce qui permet de dupliquer 
les fichiers de média source sur votre disque dur. Si vous importez des fichiers alors que la case 
est décochée, Final Cut Pro crée alors des fichiers de référence (alias de fichiers) pointant simplement sur les fichiers de média source, sans copier ces derniers. Au moment où vous sauvegardez 
des événements et des projets utilisant ces fichiers, Final Cut Pro copie uniquement les fichiers 
de référence (et non les fichiers de média source). Si après avoir sauvegardé votre projet ou 
événement, vous souhaitez remplacer les fichiers de référence par les fichiers de média source à 
proprement parler, sélectionnez les événements, puis choisissez Fichier > Organiser les fichiers 
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Montage de votre projet sur un ordinateur différent
Si vous êtes amené à devoir travailler sur votre projet et vos fichiers de média sur un autre ordinateur, plusieurs options s’offrent à vous:
• Déplacer le projet: vous pouvez supprimer le projet de son emplacement actuel et le placer 
ailleurs. Lorsque vous déplacez un projet, vous pouvez déplacer tous les événements utilisés 
dans le projet, tous les plans utilisés dans le projet ou uniquement le projet.
• Copier le projet : vous pouvez dupliquer le projet et placer la copie dans un autre emplacement. 
Lorsque vous copiez un projet, vous pouvez copier tous les événements utilisés dans le projet, 
tous les plans utilisés dans le projet ou uniquement le projet.
• Stocker des projets et des événements sur un emplacement SAN : vous pouvez stocker des fichiers 
sur un emplacement de réseau SAN, afin de pouvoir y accéder à partir de l’autre ordinateur via 
le réseau.
Remarque : Si vous avez personnalisé un effet, une transition, un titre, un générateur ou un 
thème quelconque Final Cut Pro, vous devez sauvegarder et déplacer manuellement le dossier 
des modèles Motion à un emplacement sous ~/Movies/Motion Templates.
Déplacement d’un projet et de ses événements référencés vers un autre ordinateur
1 Connectez votre périphérique de stockage externe à l’ordinateur sur lequel votre fichier de 
projet Final Cut Pro se trouve et vérifiez que le périphérique apparaît dans le Finder.
2 Vérifiez que Final Cut Pro est installé sur l’ordinateur vers lequel vous déplacez les fichiers.
3 Sur l’ordinateur qui contient votre fichier de projet Final Cut Pro, sélectionnez le projet et la 
bibliothèque d’événements.
4 Choisissez Fichier > Déplacer le projet. 
5 Dans la fenêtre qui s’affiche, procédez comme suit :
a Choisissez votre périphérique de stockage externe dans le menu local Emplacement.
b Sélectionnez «Déplacer le projet et les événements référencés ».
En sélectionnant cette option, vous déplacez le fichier du projet et tous les événements réfé-
rencés par le projet (ainsi que tous les plans qu’ils contiennent) sur le disque sélectionné dans 
le menu local Emplacement.
Pour en savoir plus sur les options de cette fenêtre, consultez la section Organisation des projets dans la bibliothèque de projets à la page 92.
c Cliquez sur OK.
L’icône et les événements du projet disparaissent de leur emplacement dans la bibliothèque 
de projets et la bibliothèque d’événements et s’affichent au-dessous de l’icône de périphé-
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6 Fermez Final Cut Pro, puis déconnectez le périphérique de stockage de votre ordinateur.
AVERTISSEMENT : Ne débranchez pas de périphérique si Final Cut Pro l’utilise.
7 Connectez le périphérique de stockage à l’ordinateur vers lequel vous souhaitez déplacer votre 
projet et vérifiez que le périphérique apparaît dans le Finder.
8 Ouvrez Final Cut Pro, puis ouvrez la bibliothèque de projets.
Le projet déplacé apparaît dans la bibliothèque de projets en dessous du périphérique de 
stockage connecté.
Remarque : Si le périphérique de stockage ne s’affiche pas dans la bibliothèque de projets, 
consultez la section Problèmes courants relatifs à la gestion des médias à la page 434.
9 Pour faire passer le projet du périphérique de stockage au nouvel ordinateur, sélectionnez-le, 
puis choisissez Fichier > Déplacer le projet.
10 Dans la fenêtre qui s’affiche, procédez comme suit :
a Choisissez le nouvel ordinateur dans le menu local Emplacement.
b Sélectionnez «Déplacer le projet et les événements référencés ».
c Cliquez sur OK.
L’icône et les événements du projet disparaissent du périphérique de stockage externe et 
s’affichent sous le disque de démarrage (icône représentant une maison) dans la bibliothèque 
de projets et l’événement contenant les médias du projet s’affiche sous le disque de démarrage 
dans la bibliothèque d’événements.
Copie d’un projet et de ses plans vers un autre ordinateur
1 Connectez votre périphérique de stockage externe à l’ordinateur sur lequel votre fichier de 
projet Final Cut Pro se trouve et vérifiez que le périphérique apparaît dans le Finder.
2 Vérifiez que Final Cut Pro est installé sur l’ordinateur vers lequel vous copiez les fichiers.
3 Sur l’ordinateur qui contient votre fichier de projet Final Cut Pro, sélectionnez le projet et la 
bibliothèque d’événements.
4 Cliquez sur votre projet tout en maintenant la touche Contrôle enfoncée et choisissez Dupliquer 
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5 Dans la fenêtre qui s’affiche, procédez comme suit :
a Choisissez votre périphérique de stockage externe dans le menu local Emplacement.
b Sélectionnez «Dupliquer le projet et les plans utilisés ».
Cette option permet de copier les fichiers de projet et les fichiers de média utilisés par le 
fichier de projet.
Pour en savoir plus sur les options de cette fenêtre, consultez la section Organisation des projets dans la bibliothèque de projets à la page 92.
c Saisissez un nom évocateur dans le champ « Nouveau nom de l’événement ».
Si vous n’indiquez pas de nom pour l’événement, il reprend alors le même que celui de 
votre projet.
d Cliquez sur OK.
L’icône et les événements du projet s’affichent sous l’icône du périphérique de stockage (indiquant qu’ils ont été copiés et déplacés à un nouvel emplacement).
6 Fermez Final Cut Pro, puis débranchez le périphérique de stockage de votre ordinateur.
Remarque : Il est impossible de débrancher un périphérique si Final Cut Pro l’utilise.
7 Connectez le périphérique de stockage à l’ordinateur vers lequel vous souhaitez déplacer votre 
projet et vérifiez que le périphérique apparaît dans le Finder.
8 Ouvrez Final Cut Pro, puis ouvrez la bibliothèque de projets.
Le projet copié apparaît dans la bibliothèque de projets en dessous du périphérique de 
stockage connecté.
Remarque : Si le périphérique de stockage ne s’affiche pas dans la bibliothèque de projets, 
consultez la section Problèmes courants relatifs à la gestion des médias à la page 434.
9 Pour copier les fichiers de projet et de média du périphérique de stockage vers le nouvel ordinateur, faites glisser le projet sur l’icône du dossier de départ dans la bibliothèque de projets.
10 Dans la fenêtre qui s’affiche, procédez comme suit :
a Choisissez le nouvel ordinateur dans le menu local Emplacement.
b Sélectionnez «Dupliquer le projet et les événements référencés ».Chapitre 15 Gestion des fichiers de média 427
c Cliquez sur OK.
Le projet s’affiche au-dessous du disque de démarrage (icône représentant une maison) dans la 
bibliothèque de projets et l’événement contenant les médias du projet s’affiche au-dessous du 
disque de démarrage dans la bibliothèque d’événements.
Vous pouvez maintenant localiser votre projet dans la bibliothèque de projets et commencer le 
montage. Toute modification se voit enregistrée dans la copie située sur le disque de démarrage 
du nouvel ordinateur.
Si une icône d’avertissement s’affiche, par exemple pour signaler un média ou un projet manquant ou si vous ne trouvez pas votre projet dans la bibliothèque de projets Final Cut Pro, complétez les étapes dans la tâche pour vérifier que celle-ci s’est exécutée correctement. Pour en 
savoir plus, consultez Problèmes courants relatifs à la gestion des médias à la page 434.
Utilisation d’un emplacement SAN pour monter votre projet sur un autre ordinateur
Vous pouvez commencer à monter un projet à travers un réseau en utilisant un emplacement 
SAN, puis poursuivre votre travail à partir d’un autre ordinateur via le même emplacement SAN. 
Pour mettre l’emplacement SAN à la disposition des autres ordinateurs du réseau, utilisez la commande Supprimer pour déconnecter l’emplacement SAN de l’ordinateur original. 
1 Suivez la procédure d’ajout d’un emplacement SAN décrite dans Utilisation d’emplacements SAN 
pour des événements et des projets à la page 428.
2 Créez un projet sur l’emplacement SAN ou copiez ou déplacez votre projet dans 
l’emplacement SAN.
3 Pour supprimer l’emplacement SAN et le mettre à la disposition des autres ordinateurs du réseau, 
sélectionnez l’emplacement SAN dans la bibliothèque d’événements ou la bibliothèque de projets, puis choisissez Fichier > Supprimer l’emplacement SAN.
L’emplacement SAN disparaît alors de la bibliothèque d’événements et de la bibliothèque 
de projets
4 Pour accéder à l’emplacement SAN à partir de l’autre ordinateur, suivez la procédure d’ajout d’un 
emplacement SAN décrite dans Utilisation d’emplacements SAN pour des événements et des 
projets à la page 428.Chapitre 15 Gestion des fichiers de média 428
Veillez à accéder au même dossier que celui utilisé à l’étape 1.
L’emplacement SAN apparaît sous forme d’emplacement de stockage dans la bibliothèque 
d’événements et dans la bibliothèque de projets sur le deuxième ordinateur. Vous pouvez à 
présent utiliser cet ordinateur pour monter n’importe quel événement ou projet stocké sur cet 
emplacement SAN. 
Utilisation d’emplacements SAN pour des événements et des projets
Vous pouvez enregistrer vos événements et vos projets sur un réseau de stockage SAN. Ces 
emplacements de stockage en réseau vous offrent un plus grand nombre d’options pour le 
stockage de vos fichiers de données et la rationalisation de votre flux de production à travers un 
réseau local haute vitesse. 
Bien qu’il soit possible d’accéder à des emplacements SAN à partir de différents ordinateurs 
sur un réseau, un emplacement SAN ne peut être utilisé que par une seule copie installée de 
Final Cut Pro à la fois. Si vous disposez d’événements ou de projets stockés sur un emplacement 
SAN, vous devez supprimer cet emplacement dans Final Cut Pro pour le mettre à la disposition 
des autres ordinateurs du réseau.
La fonction d’emplacement SAN nécessite un volume SAN, tel qu’un volume Xsan connecté via 
le protocole FCP (Fibre Channel Protocol).
Ajout d’un emplacement SAN
1 Choisissez Fichier > Ajouter un emplacement SAN.
2 Dans la fenêtre qui apparaît, naviguez jusqu’à un dossier situé sur un périphérique de stockage 
ou un ordinateur connecté au réseau.
Le dossier que vous avez sélectionné apparaît sous la forme d’un emplacement de stockage 
dans la bibliothèque d’événements et dans la bibliothèque de projets.
Emplacement 
SAN sur votre 
réseau.
Vous pouvez utiliser l’emplacement SAN comme n’importe quel autre périphérique de stockage 
affiché dans la bibliothèque d’événements et dans la bibliothèque de projets. Vous pouvez, 
par exemple, créer des événements ou des projets sur l’emplacement SAN, ou bien, y copier et 
déplacer des événements ou des projets.
Suppression d’un emplacement SAN
1 Sélectionnez l’emplacement SAN à supprimer dans la bibliothèque d’événements ou la bibliothèque de projets.
2 Choisissez Fichier > Supprimer l’emplacement SAN.
L’emplacement SAN disparaît alors de la bibliothèque d’événements et de la bibliothèque de 
projets et devient (avec tous les événements ou projets qu’il contient) disponible pour les autres 
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Création et gestion des archives de caméra
Vous avez la possibilité de créer une archive de caméra (copie de sauvegarde) du contenu de 
votre caméra ou caméscope. (Il est important de noter que vous ne pouvez pas créer d’archive 
pour un signal vidéo en direct, tel que celui produit par une caméra iSight.) Pour protéger votre 
média, il est recommandé d’enregistrer votre archive sur un disque ou une partition différente de 
celle sur laquelle vous stockez vos fichiers de médias utilisés avec Final Cut Pro.
Puisque vous pouvez importer des médias dans Final Cut Pro à partir d’une archive, il peut 
s’avérer utile d’archiver le média sur votre matériel si vous souhaitez effectuer l’une des actions 
suivantes:
• vider rapidement le contenu de votre caméra ou de votre caméscope pour avoir la possibilité 
d’enregistrer immédiatement d’autre contenu et ne pas devoir attendre une importation dans 
Final Cut Pro, qui peut prendre un certain temps
• importer le média archivé sur plusieurs ordinateurs sans devoir le conserver sur le caméscope ;
• garder une archive du média d’une caméra que vous pouvez parcourir facilement sans avoir à 
l’importer dans Final Cut Pro.
Consultez la section Accès aux médias sur une archive ou une image disque à la page 40 pour en 
savoir plus sur l’importation de média dans Final Cut Pro depuis une archive de caméra.
Archivage du média sur votre caméra ou caméscope à système de fichiers
1 Si vous souhaitez enregistrer l’archive sur un périphérique de stockage externe, branchez-le sur 
votre ordinateur.
2 Branchez ensuite votre caméra ou caméscope sur votre ordinateur à l’aide du câble prévu à cet 
effet et activez l’appareil.
Si vous utilisez un caméscope, faites-le passer en mode de connexion PC. Le nom de ce mode de 
transfert varie selon le modèle de votre matériel. Il se peut que votre caméscope passe automatiquement en mode de « connexion » si vous activez le mode lecture lorsqu’il est connecté à votre 
ordinateur. Pour en savoir plus, consultez la documentation fournie avec votre caméscope.
Remarque : Si vous connectez un caméscope DVD à votre Mac, il se peut que l’application 
Lecteur DVD s’ouvre. Si cela se produit, il vous suffit de fermer l’application.
3 Dans Final Cut Pro, cliquez sur le bouton Importation de médias situé complètement à gauche 
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4 Dans la fenêtre Importation des médias qui s’affiche, sélectionnez le périphérique dont vous souhaitez archiver le contenu dans la liste de caméras située sur la gauche.
Modifiez l’apparence des plans à 
l’aide de ces commandes.
Le média sur le support 
s’affiche à cet endroit.
Commandes de lecture
5 Cliquez sur le bouton Créer une archive situé dans le coin inférieur gauche de la fenêtre.
6 Dans le champ « Créer une archive de caméra », saisissez un nom pour l’archive.
7 Choisissez un emplacement dans le menu local Destination pour enregistrer l’archive, puis cliquez sur OK.
Remarque : Il est recommandé d’enregistrer votre archive sur un disque ou une partition diffé-
rente de celle sur laquelle vous stockez vos fichiers de médias utilisés avec Final Cut Pro.
L’archive de caméra est conservée sur votre disque dur. Vous pouvez monter les archives comme 
s’il s’agissait d’un caméscope à système de fichiers et parcourir leur contenu ou importer les 
médias des archives de caméra dans Final Cut Pro. Pour en savoir plus, consultez Accès aux 
médias sur une archive ou une image disque à la page 40.
Remarque : Lorsque le disque contenant l’archive est connecté, il s’affiche automatiquement 
dans la liste d’archives de caméra dans Final Cut Pro.
Archivage du média sur votre caméra ou caméscope à système de bande
1 Si vous souhaitez enregistrer l’archive sur un périphérique de stockage externe, branchez-le sur 
votre ordinateur.
2 Branchez ensuite votre caméra ou caméscope sur votre ordinateur à l’aide du câble prévu à cet 
effet et activez l’appareil.
Si vous utilisez un caméscope, faites-le passer en mode de connexion PC. Le nom de ce mode de 
transfert varie selon le modèle de votre matériel. Il se peut que votre caméscope passe automatiquement en mode de « connexion » si vous activez le mode lecture lorsqu’il est connecté à votre 
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3 Dans Final Cut Pro, effectuez l’une des opérations suivantes:
• Choisissez Fichier > Importer > Média (ou appuyez sur Commande + I).
• Cliquez sur le bouton Média à l’extrémité gauche de la barre d’outils.
4 Dans la fenêtre Importation des médias qui s’affiche, sélectionnez le périphérique dont vous souhaitez archiver le contenu dans la liste de caméras située sur la gauche.
5 Cliquez sur le bouton Créer une archive situé dans le coin inférieur gauche de la fenêtre.
6 Dans le champ « Créer une archive de caméra », saisissez un nom pour l’archive.
7 Choisissez un emplacement dans le menu local Destination pour enregistrer l’archive, puis cliquez sur OK.
Remarque : Pour protéger votre média, il est recommandé d’enregistrer votre archive sur un 
disque ou une partition différente de celle sur laquelle vous stockez vos fichiers de médias utilisés avec Final Cut Pro.
Final Cut Pro lance l’archivage à partir de la position sur la bande. L’archivage se poursuit 
jusqu’à ce que :
• la fin de la bande soit atteinte ;
• vous interrompiez manuellement l’archivage en cliquant sur Arrêter l’importation ou Fermer 
(pour fermer la fenêtre Importation des médias).
L’archive de caméra est conservée sur votre disque dur. Vous pouvez monter les archives comme 
s’il s’agissait d’un caméscope à système de fichiers et parcourir leur contenu ou importer les 
médias des archives de caméra dans Final Cut Pro. Pour en savoir plus, consultez Accès aux 
médias sur une archive ou une image disque à la page 40.Chapitre 15 Gestion des fichiers de média 432
Lorsque le disque contenant l’archive est connecté, il s’affiche automatiquement dans la liste 
d’archives de caméra dans Final Cut Pro, pour autant que l’archive se trouve dans l’un des deux 
emplacements suivants: 
• /Utilisateurs/nom d’utilisateur/Séquences/Final Cut Camera Archives/
• La racine du disque de démarrage
Déplacement ou copie d’une archive de caméra
1 Dans le Finder, sélectionnez l’archive de caméra que vous souhaitez déplacer ou copier.
2 Procédez de l’une des manières suivantes:
• Pour déplacer l’archive de caméra sur votre disque local : faites glisser l’archive de caméra sur son 
nouvel emplacement.
• Pour copier l’archive de caméra sur votre disque local : en maintenant la touche Option enfoncée, 
faites glisser l’archive de caméra sur un nouvel emplacement sur votre disque local.
• Pour copier l’archive de caméra sur un périphérique de stockage externe : faites glisser l’archive de 
caméra vers un emplacement sur votre périphérique de stockage externe.
Suppression d’une archive de caméra
Les archives de caméra sont peu volumineuses comparées à d’autres fichiers de média et n’ont, 
par conséquent, souvent pas de raison d’être supprimées. Toutefois, vous pouvez supprimer une 
archive de caméra à tout moment.
1 Dans le Finder, sélectionnez une archive de caméra.
2 Maintenez la touche Contrôle enfoncée et choisissez « Placer dans la Corbeille » dans le menu 
local qui s’affiche.
3 Tout en maintenant la touche Contrôle enfoncée, cliquez sur l’icône de la Corbeille située dans le 
Dock, puis choisissez Vider la Corbeille dans le menu contextuel.
Important : Vider la corbeille supprime définitivement l’archive de caméra.
Solutions aux problèmes communs des gestions des médias
Icônes d’avertissement
Lorsque des images s’affichent en rouge avec un triangle d’avertissement jaune dans la timeline ou dans l’événement, Final Cut Pro vous signale en fait qu’une partie de votre projet ou de 
votre événement est manquante. Plusieurs raisons peuvent expliquer la disparition de plans, 
d’événements, de fichiers de média et d’effets: le déplacement de projets et d’événements d’un 
ordinateur à un autre et la gestion active du dossier Events (Événements) ou Projects (Projets) de 
Final Cut Pro à l’aide du Finder sont deux des principales explications.
Pour en savoir plus sur l’emplacement des événements, des plans, des projets et des fichiers, 
consultez la section Emplacement de vos fichiers de média et de projet à la page 407.
Icône Alerte Description
Événements et plans Final Cut Pro
Événement manquant Le dossier de l’événement n’est 
pas disponible.
Cet avertissement s’affiche si votre 
événement a été placé dans la 
Corbeille, si celui-ci ou un projet a 
été déplacé ou si vous avez consolidé le média d’un autre projet.Chapitre 15 Gestion des fichiers de média 433
Icône Alerte Description
Plan manquant Un plan utilisé dans un projet 
Final Cut Pro ou dans un événement n’est pas disponible.
Cet avertissement s’affiche si le 
plan a été placé dans la Corbeille, 
si celui-ci ou un événement a été 
déplacé ou si vous avez consolidé 
le média d’un autre projet.
Caméra manquante Aucune caméra contenant des 
fichiers utilisés dans Final Cut Pro 
n’est connectée à votre système.
Pour ne pas recevoir cet avertissement, créez une copie du média 
lorsque vous l’importez. Consultez 
Organisation des fichiers lors de 
l’importation à la page 41 pour en 
savoir plus.
Fichiers de média
Fichier manquant Un fichier n’est pas disponible 
dans le Finder.
Cet avertissement s’affiche si le 
fichier a été déplacé ou renommé 
dans le Finder, si un événement 
ou un projet a été déplacé ou si 
vous avez consolidé le média d’un 
autre projet.
Fichier modifié Un fichier de média a été modifié 
par une application autre que 
Final Cut Pro.
Fichier proxy manquant Un fichier proxy créé par 
Final Cut Pro ne se trouve pas à 
son emplacement prévu dans 
le Finder.
Consultez Transcodage des fichiers 
de média à la page 415 pour en 
savoir plus.
Effets Final Cut Pro
Effet manquant Un effet est manquant dans 
Final Cut Pro.
Générateur manquant Un générateur est manquant dans 
Final Cut Pro.
Titre manquant Un titre est manquant dans 
Final Cut Pro.
Transition manquante Une transition est manquante dans 
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Problèmes courants relatifs à la gestion des médias
Cette section décrit des problèmes courants relatifs à la gestion de média et leurs solutions. 
Si un projet ne s’affiche pas sur votre périphérique de stockage externe
m Assurez-vous que les dossiers Final Cut Projects et Final Cut Events se trouvent à la racine du 
périphérique de stockage.
m Si le périphérique de stockage ne s’affiche pas dans la liste des appareils de la bibliothèque de 
projets, vous pouvez copier ou déplacer manuellement les dossiers Final Cut Projects et Final Cut 
Events vers le dossier Séquences.
m Vous pouvez également ajouter manuellement différents dossiers de projets ou d’événements 
indépendamment à tout dossier Final Cut Projects ou Final Cut Events.
Pour en savoir plus, consultez Présentation de la gestion de média à la page 407.
Si vous importez directement un fichier d’un disque dur et changez son nom dans le Finder
Il se peut qu’un avertissement lié à un fichier manquant s’affiche si vous en déplacez ou en 
renommez un dans le Finder. 
m Dans le Finder, réattribuez le nom du fichier qu’il possédait à l’origine dans le navigateur 
d’événements.
Si vous avez annulé une importation
Si vous avez annulé une importation et que vous n’avez pas importé un plan entier, celui-ci est 
signalé par une icône représentant une caméra dans son coin inférieur gauche.
Icône de caméra
m Suivez les instructions reprises dans le paragraphe « Réimportation d’un plan » de la section 
Importation à partir des caméras à système de fichiers à la page 22.
Si votre ordinateur semble ralentir lorsque Final Cut Pro réalise des tâches de gestion 
du média
Final Cut Pro enregistrant automatiquement toutes les modifications que vous apportez à un 
projet, ce dernier est alors à jour lorsque vous relancez Final Cut Pro à l’issue d’une coupure de 
courant. Si Final Cut Pro effectuait des tâches de gestion du média à l’arrière-plan, vous pouvez 
alors redémarrer ces processus manuellement à l’aide des commandes «Organiser les fichiers 
d’événements » et «Organiser les fichiers de projet ». 
1 Sélectionnez le ou les événements de votre choix dans la bibliothèque d’événements ou un 
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2 Procédez de l’une des manières suivantes:
• Pour redémarrer les tâches de gestion d’arrière-plan pour un événement sélectionné : Choisissez 
Fichier > Organiser les fichiers d’événements.
• Pour redémarrer les tâches de gestion d’arrière-plan pour un projet sélectionné : choisissez 
Fichier > Organiser les fichiers de projet.
Si votre caméra DSLR n’est pas reconnue par Final Cut Pro
m Suivez les instructions dans Importation à partir d’un appareil photo numérique à la page 31.16
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Présentation des préférences et des métadonnées
Dans Final Cut Pro, il vous est possible de modifier les réglages de préférences pour indiquer 
comment votre média source s’importe dans l’application, le mode de reproduction de vos plans 
et le type de montage applicable à vos plans dans la timeline.
Vous pouvez aussi afficher et modifier les renseignements associés à un plan donné, appelées les 
métadonnées d’un plan. Ces métadonnées comprennent des informations relatives aux fichiers 
de média source d’un plan ainsi que celles que vous ajoutez au plan, par exemple des notes. Pour 
en savoir plus, consultez Affichage et modification des métadonnées de plans à la page 451.
Préférences Final Cut Pro
Modification des réglages de préférences
Une préférence modifie le comportement d’une fonctionnalité particulière de Final Cut Pro. 
La plupart de ces réglages de préférences peuvent être activés ou désactivés à tout moment. 
Les sections suivantes décrivent les préférences de Final Cut Pro de façon plus détaillée.
Ouverture des préférences de Final Cut Pro
m Choisissez Final Cut Pro > Préférences (ou appuyez sur Commande +Virgule), puis cliquez sur le 
bouton d’une fenêtre en haut de la fenêtre pour l’ouvrir.
Copie des préférences Final Cut Pro entre ordinateurs
Vous pouvez copier les réglages des préférences de Final Cut Pro vers un autre Mac sur lequel 
Final Cut Pro est aussi installé afin que les réglages soient identiques sur les deux ordinateurs.
1 Le fichier contenant les réglages des préférences se trouve à l’emplacement suivant :
/Utilisateurs/nom d’utilisateur/Bibliothèque/Préférences/com.apple.FinalCut.plist
2 Copier le fichier des réglages des préférences au même emplacement sur un autre Mac.
Si nécessaire, remplacez toute autre version du fichier à cet emplacement.
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Modification des préférences
Les préférences Montage influent sur les comportements liés au montage dans Final Cut Pro.
Contrôle du temps
• Contrôle du temps:utilisez ce menu local pour choisir le mode de mesure du temps pour 
Final Cut Pro. Les changements apportés à ce réglage affectent l’affichage du temps (pour 
l’emplacement du skimmer ou de la tête de lecture) dans le panneau de contrôle repris au 
milieu de la barre d’outils, ainsi que les opérations de trim et de navigation dans Final Cut Pro. 
Les options suivantes vous sont proposées:
• Affichage du timecode
• Affichage du timecode avec sous-images
• Durée en nombre d’images
• Durée en secondes
Timeline
• Afficher les commentaires détaillés sur le trimming : cochez cette case pour activer la présentation de deux fenêtres juxtaposées dans le visualiseur pour bénéficier d’un retour plus précis 
sur un point de montage lorsque deux plans contigus sont manipulés. Par exemple, pour un 
simple montage Ripple ou Roll, cet affichage reprend le point d’arrivée du plan de gauche et 
le point de départ du plan de droite.
• Placer la tête de lecture après l’opération de montage : cochez cette case pour que la tête de 
lecture se place automatiquement sur la timeline à la fin du dernier montage. Par exemple, si 
vous insérez un plan entre deux autres sur la timeline, la tête de lecture se place automatiquement entre le plan inséré et celui immédiatement suivant.
Unités de l’inspecteur
• Unités de l’inspecteur: ce menu local vous permet de définir l’affichage des valeurs dans les 
commandes de l’inspecteur pour les effets Transformation, Rognage et Distorsion.
• Pixels:sélectionnez ce réglage pour afficher les valeurs exprimées en pixels.
• Pourcentages:sélectionnez ce réglage pour afficher les valeurs exprimées en pourcentages.Chapitre 16 Préférences et métadonnées 438
Audio
• Afficher les formes d’onde de référence : cochez cette case pour modifier l’apparence de l’arrièreplan de la partie audio d’un plan de sorte à afficher les formes d’onde de référence. Une forme 
d’onde de référence affiche la résolution maximale de la forme d’onde audio active. En faisant 
appel à un facteur d’annulation sur la tonalité, les formes d’onde de référence permettent de 
distinguer la forme du son plus clairement. Lorsque la forme d’onde active change de forme 
(par exemple, se réduit lorsque le volume d’un plan est faible), celle de référence reste intégralement visible pour faciliter le montage.
Images fixes
• Durée de montage de x secondes:utilisez cette case de valeur pour régler la durée de montage 
en secondes par défaut des images fixes et des plans d’arrêt sur image.
Transitions
• Durée de x secondes: utilisez cette case de valeur pour régler la durée en secondes par défaut 
des transitions.
Avertissements de dialogue
• Tout réinitialiser: cliquez sur ce bouton pour réinitialiser l’affichage de toutes les zones de dialogue d’avertissement.
Préférences de lecture
Les préférences de lecture influent sur les performances en lecture et de rendu de Final Cut Pro.
Rendu
• Rendu en arrière-plan : cochez cette case pour activer les opérations de rendu de Final Cut Pro, 
qui s’effectuent lorsque le système est inactif.
• Démarrer après:utilisez cette case de valeur pour définir la durée d’inactivité de votre système, 
exprimée en secondes, avant que le rendu en arrière-plan de Final Cut Pro se lance.
Lecture
• Utiliser un média proxy : cliquez sur ce bouton pour exploiter du média proxy de qualité 
moyenne (converti à la moitié de la résolution d’origine) plutôt que du média en résolution 
complète lors de la lecture. Choisir cette option augmente les performances de lecture, bien 
que la qualité vidéo soit moindre. Dans Final Cut Pro, le média proxy est au format Apple 
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• Utiliser un média original ou optimisé : ce bouton vous permet d’exploiter du média optimisé 
pour la lecture. Si aucun média optimisé n’est disponible, Final Cut Pro fait appel au média 
d’origine pour la lecture. Dans ce cas, utilisez le menu local Qualité de lecture pour indiquer 
d’utiliser toujours le plus haut niveau de qualité vidéo pour la lecture, ou de faire appel à de la 
vidéo de résolution plus modeste pour bénéficier de meilleures performances en lecture. Dans 
Final Cut Pro, le média optimisé est au format Apple ProRes 422.
• Qualité de lecture : choisissez Haute qualité dans ce menu local pour donner la priorité à la qualité, ou sélectionnez Meilleures performances pour privilégier les performances.
• Créer des média optimisés pour des plans multicam: cochez cette case pour transcoder automatiquement la vidéo de plans multicam au codec Apple ProRes 422, ce qui assure de meilleures 
performances lors du montage et des temps de rendu plus courts.
• Avertir lors de l’omission d’images durant la lecture : cochez cette case pour que Final Cut Pro 
vous avertisse lorsque des images sont abandonnées (Drop-Frame) lors de la lecture.
• Avertir lors de l’omission d’images à cause d’une mauvaise performance du disque dur: cochez 
cette case pour que Final Cut Pro vous avertisse lorsque des images sont abandonnées (DropFrame) pendant la lecture à cause des performances du disque dur.
Durée de pre-roll
• Durée de pre-roll :Utiliser la case de valeur pour définir la durée à lire avant une audition ou 
avant la position du skimmer ou de la tête de lecture lors de l’utilisation de la commande Lire 
le contexte.
Durée de post-roll
• Durée de post-roll :Utiliser la case de valeur pour définir la durée à lire avant une audition ou 
avant la position du skimmer ou de la tête de lecture lors de l’utilisation de la commande Lire 
le contexte.
Arrière-plan du lecteur
• Arrière-plan du lecteur:utilisez ce menu local pour choisir un modèle pour le visualiseur. La 
couleur sélectionnée est alors visible dans le cas de plans transparents, entièrement ou en 
partie, ou de plans ne tenant pas complètement sur l’image.
Sortie A/V
• Sortie A/V : utilisez ce menu local pour choisir un équipement audio/vidéo ou un moniteur 
externe pour la sortie. La sortie A/V nécessite une interface vidéo matérielle et logicielle de 
tierce partie et n’est disponible que sous OS X Lion 10.7.2 ou ultérieur. Pour en savoir plus, 
consultez Lecture sur un moniteur externe à la page 85.Chapitre 16 Préférences et métadonnées 440
Préférences d’importation
Lorsque vous importez du média dans Final Cut Pro par le biais de la fenêtre Importation des 
médias, vous pouvez alors personnaliser vos réglages d’importation chaque fois que vous importez des fichiers. Si vous faites glisser cependant du média directement à partir du Finder dans 
Final Cut Pro, Final Cut Pro s’appuie sur les réglages d’importation que vous avez sélectionnés dans 
la fenêtre Importer des préférences de Final Cut Pro.
Organisation
• Copier les fichiers dans le dossier Final Cut Events:duplique les fichiers de médias et place part 
la copie dans le dossier Final Cut Events stocké sur votre système. Si vous importez un média 
depuis un autre disque ou volume, ou si vous voulez conserver une copie de tous les fichiers de 
média qui ont été importés dans Final Cut Pro au même emplacement, cochez cette case.
• Importer des dossiers sous forme de collections de mots-clés: crée une collection de mots-clés pour 
chaque dossier dans les fichiers en cours d’importation. Si les fichiers en cours d’importation se 
trouvent dans des dossiers dont le nom est évocateur, sélectionnez cette option pour conserver 
l’organisation des fichiers existante dans le Finder. (Il est important de noter que, bien que les 
collections de mots-clés ne soient pas imbriquées dans la bibliothèque d’événements, chaque 
fichier obtient une collection de mots-clés pour chaque dossier dans lequel il figure, quelle que 
soit la profondeur du sous-dossier dans l’arborescence du dossier en question.)
Transcodage
• Créer un média optimisé : cette option transcode la vidéo au format de codec Apple ProRes 422, 
lequel assure de meilleures performances lors du montage, des temps de rendu réduits et une 
qualité colorimétrique supérieure lors du compositing. Si le format original de la caméra peut 
être monté en offrant de bons résultats, cette option est estompée.
• Créer un média proxy : cette option permet de transcoder de la vidéo au format du codec Apple 
ProRes 422 (Proxy), ce qui génère des fichiers en haute qualité, pratiques pour le montage 
déconnecté. Les fichiers vidéo proxy occupent sensiblement moins d’espace disque, vous offrant 
souvent la possibilité de travailler sur un ordinateur portable même si celui-ci dispose de moins 
de mémoire et de puissance qu’un ordinateur de bureau. Cette option transcode des images 
fixes en fichiers JPEG (si le fichier original ne possède pas d’informations de canal alpha) ou PNG 
(dans le cas contraire).
Remarque : Lors du transcodage de fichiers, Final Cut Pro conserve toujours le média original 
en vue de son utilisation ultérieure. Pour en savoir plus sur l’emplacement des fichiers de média 
originaux, de média proxy et de média transcodés, consultez Emplacement de vos fichiers de 
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Vidéo
• Analyser la balance des couleurs: analyse la piste vidéo des plans pour détecter les problèmes 
de dominante de couleur et de contraste. La balance des couleurs est automatiquement corrigée lorsque vous faites glisser le plan sur la timeline. Vous pouvez corriger les problèmes de 
balance des couleurs d’un plan inclus dans un événement en activant la fonction Balance dans 
la section Couleur de l’inspecteur vidéo.
Vous pouvez désactiver le réglage automatique de la couleur à tout moment. Dans ce cas, le 
plan conserve les couleurs enregistrées à l’origine dans le projet.
• Rechercher les personnes: effectue l’analyse des plans pour détecter la présence de personnes 
et des types de plans. Une fois l’analyse effectuée, les mots-clés suivants sont ajoutés au plan 
le cas échéant : Une personne, Deux personnes, Groupe, Gros plan, Plan moyen ou Plan élargi. 
La case « Consolider les résultats de recherche de personnes » simplifie et récapitule tous les 
mots-clés d’analyse de ce type de recherche. Pour en savoir plus, consultez Options d’analyse 
des vidéos et des images fixes à la page 49. Si vous procédez à l’analyse pour rechercher des 
personnes, il est recommandé de cocher également la case « Créer des collections intelligentes 
après l’analyse ».
• Créer des collections intelligentes après l’analyse : crée une collection intelligente pour chaque 
mot-clé appliqué lors de l’analyse de plans vidéo pour rechercher des problèmes de stabilisation ou des personnes. Les collections intelligentes s’affichent dans un dossier à l’intérieur de 
l’événement.
Audio
• Analyser et résoudre les problèmes audio : analyse l’audio et corrige automatiquement tout 
bourdonnement, bruit et problème de tonalité. Vous pouvez à tout moment désactiver les corrections automatiques de l’audio ; dans ce cas, l’audio est lue telle qu’enregistrée à l’origine.
• Scinder l’audio mono et grouper l’audio stéréo : analyse et regroupe les canaux audio en mono 
double ou en stéréo, selon les résultats de l’analyse. Pour en savoir plus sur les canaux audio, 
consultez la section Configuration des canaux audio à la page 176.
• Supprimer les canaux silencieux : les canaux audio sont analysés et ceux laissés silencieux sont 
automatiquement supprimés.
Remarque : Il vous est possible de récupérer la configuration audio d’origine après l’importation. Consultez Configuration des canaux audio à la page 176. 
Préférences de destinations
Pour modifier les destinations de partage reprises dans le menu Partager, utilisez la fenêtre 
Destinations des préférences de Final Cut Pro. Les destinations de la liste Destinations (reprise au 
côté gauche de la fenêtre Destinations) apparaissent également dans le sous-menu Partager du 
menu Fichier et dans le menu local qui s’affiche lorsque vous cliquez sur le bouton Partager dans 
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Lorsque vous ouvrez Final Cut Pro pour la première fois, un ensemble de destinations par défaut 
apparaît dans la liste Destinations. Vous avez la possibilité d’ajouter d’autres destinations et en 
personnaliser au besoin. Pour connaître les destinations que vous pouvez ajouter, sélectionnez 
Ajouter une destination dans la liste Destinations. Lorsque vous sélectionnez une destination 
dans la liste Destinations, ses réglages s’affichent à droite. 
Les réglages disponibles pour chaque destination sont décrits ci-dessous. Pour en savoir plus sur 
l’ajout et la modification de destinations, consultez Utilisation de destinations à la page 447.
DVD et Blu-ray
Faites appel à ces destinations pour graver votre projet ou plan sur un DVD en définition standard ou disque compatible Blu-ray, ou pour créer un fichier d’image disque (.img) que vous 
pouvez copier ensuite sur un lecteur externe ou graver sur disque.
Remarque : La destination Blu-ray ne s’affiche pas par défaut. Pour l’ajouter à la liste Destinations, 
consultez Utilisation de destinations à la page 447.
Les destinations DVD et Blu-ray comprennent les réglages suivants:
• Périphérique de sortie : reprend les dispositifs de sortie adaptés à votre système, notamment les 
lecteurs optiques et le disque dur de l’ordinateur.
Vous pouvez passer par votre disque dur pour créer un fichier d’image disque (.img) que vous 
pouvez copier ensuite sur un lecteur externe ou graver sur un DVD. 
• Couches: affiche les couches disponibles sur le média de destination. 
• Automatique : détecte automatiquement le type de disque que vous pouvez utiliser.
• Simple couche : identifie le disque en tant que disque simple couche. Vous pouvez faire appel 
à cette option pour forcer un disque double couche faisant office de disque simple couche.
• Double couche : identifie le disque en tant que disque double couche. Cette option peut 
forcer au besoin l’image disque à être formatée en disque double couche si vous choisissez 
l’option Disque dur pour désigner votre dispositif de sortie.
Important : En fonction de la durée du projet, le choix de Double couche en cas d’usage d’un 
disque simple couche peut entraîner une erreur lors de la gravure du disque.Chapitre 16 Préférences et métadonnées 443
• Modèle de disque : affiche les modèles de disque proposés.
• Au chargement du disque : affiche l’opération automatique qui s’exécute au moment de la lecture du disque.
• Afficher le menu : affiche le menu principal.
• Lire le film: lance immédiatement la lecture du film.
• Marqueurs: non disponibles pour Blu-ray lors de l'utilisation d'un appareil de sortie AVCHD. 
Cocher la case pour inclure le texte des marqueurs de chapitre sous forme de sous-titres dans 
le disque généré en sortie. Les utilisateurs peuvent ainsi passer d’un marqueur de chapitre 
à l’autre en appuyant sur le bouton Chapitre suivant ou Chapitre précédent sur le lecteur 
de DVD ou Blu-ray. Pour en savoir plus sur l’utilisation de marqueurs de chapitre, consultez 
Gestion des marqueurs de chapitre et de leur vignette à la page 160.
• En boucle : disponible uniquement pour les disques Blu-ray. Cochez cette case pour ajouter 
une icône de lecture en boucle au menu.
• Arrière-plan : cliquez sur le bouton Ajouter pour ajouter un graphisme en arrière-plan.
• Graphique du logo : disponible uniquement pour les disques Blu-ray. cliquez sur le bouton 
Ajouter pour ajouter un logo.
• Graphique du titre : disponible uniquement pour les disques Blu-ray. cliquez sur le bouton 
Ajouter pour ajouter un graphisme pour le titre.
• Preview: cliquez sur Menu principal pour afficher un aperçu du menu principal. Cliquez sur 
Menu Chapitre pour afficher un aperçu du menu des chapitres. 
Adresse électronique
Utilisez cette destination pour envoyer votre projet ou plan par courrier électronique à travers le 
programme de messagerie électronique Mail d’Apple. La destination Adresse électronique crée 
automatiquement un courrier électronique qui inclut le fichier exporté.
Remarque : La destination Adresse électronique ne s’affiche pas par défaut. Pour l’ajouter à la 
liste Destinations, consultez Utilisation de destinations à la page 447.
La destination Adresse électronique inclut les réglages suivants:
• Résolution : choisissez une résolution dans le menu local. 
• Compression : choisissez « Meilleure qualité » si vous voulez bénéficier d’une compression 
optimale. Choisissez « Encodage plus rapide » si vous êtes disposé à sacrifier de la qualité pour 
obtenir un traitement plus rapide.
YouTube, Vimeo, Facebook et CNN iReport
Faites appel à ces destinations pour publier votre projet ou plan à travers votre compte YouTube, 
Vimeo, Facebook ou CNN iReport.
Remarque : La destination CNN iReport ne s’affiche pas par défaut. Pour l’ajouter à la liste 
Destinations, consultez Utilisation de destinations à la page 447.
Important : Si vous possédez plusieurs comptes pour le même site web, vous devez créer une 
destination à part pour chaque compte. Après avoir saisi les informations de compte, le nom de 
la destination se voit complété de celui du compte entre parenthèses, par exemple, « YouTube 
(nom_utilisateur) ». Si vous le désirez, vous pouvez renommer la destination pour lui attribuer un 
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Les destination web regroupent les réglages suivants:
• Ouvrir une session : la première fois que vous ouvrez une nouvelle destination web, une fenêtre 
vous permet alors de saisir les informations de votre compte. Si vous saisissez votre nom de 
compte et votre mot de passe, et cochez la case « Conserver ce mot de passe dans mon trousseau », il ne vous est alors plus nécessaire de ressaisir vos nom et mot de passe par la suite. 
Après la configuration de départ, vous pouvez cliquer sur le bouton Ouvrir une session dans 
les réglages de la destination pour saisir à nouveau ou pour modifier les informations de 
votre compte.
• Résolution : choisissez la résolution par défaut pour la destination. Si la destination est utilisée 
avec un projet ou un plan présentant une résolution inférieure à celle que vous avez sélectionnée, la résolution s’adapte pour se calquer sur celle du projet ou du plan.
• Compression : choisissez « Meilleure qualité » si vous voulez bénéficier d’une compression 
optimale. Choisissez « Encodage plus rapide » si vous êtes disposé à sacrifier de la qualité pour 
obtenir un traitement plus rapide.
• Convertir ce film en film privé : disponible uniquement pour YouTube. Si cette case est cochée, 
seuls les contacts que vous indiquez dans les paramètres de votre compte YouTube sont alors 
en mesure de visionner le film.
• Catégorie : disponible uniquement pour YouTube. Choisissez la catégorie YouTube sous laquelle 
votre film doit figurer.
• Visible par: disponible uniquement pour Facebook et pour Vimeo. Indiquez qui est en mesure 
de visionner votre film.
Enregistrer l’image active et Séquence d’images
Passez par ces destinations pour enregistrer l’image fixe d’une image vidéo quelconque 
de votre projet ou pour enregistrer un ensemble de fichiers d’images fixes, numérotés de 
façon séquentielle.
Remarque : Les destinations Enregistrer l’image active et Séquence d’images ne s’affichent pas par 
défaut. Pour ajouter l’une de ces deux à la liste Destinations, consultez Utilisation de destinations à 
la page 447.
Les destinations Enregistrer l’image active et Séquence d’images regroupent les réglages suivants:
• Exporter: choisissez un format pour le fichier exporté.
• Mettre l’image à l’échelle pour conserver les proportions: cochez cette case pour adapter l’échelle 
du fichier de sortie à des pixels carrés et conserver ainsi les proportions d’origine (entraînant 
par là même une augmentation ou une réduction du nombre de pixels à l’horizontale et à la 
verticale). 
La case n’influe que sur les projets usant des formats avec des pixels non-carrés, tels les formats 
NTSC et PAL. Si la case est décochée (réglage par défaut), le fichier en sortie reprend les proportions pixels et le même nombre de pixels à l’horizontale et à la verticale que la vidéo d’origine.
Exportation d’un fichier
Remarque : Cette destination sert de base à trois destinations dans l’ensemble par défaut : Fichier 
master, Dispositifs Apple 720p et Dispositifs Apple 1080p. Lorsque vous créez ou modifiez des destinations dans les préférences de Final Cut Pro, cette destination s’appelle Exporter le fichier.
Utilisez cette destination pour exporter votre projet ou plan sous forme de fichier de film (audio 
+ vidéo), de fichier vidéo (sans audio) ou de fichier audio (sans vidéo). Cette destination permet 
d’exporter des fichiers destinés aux appareils Apple, aux ordinateurs et pour l’hébergement 
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Vous pouvez personnaliser la destination Exporter le fichier en choisissant l’une des résolutions 
proposées en fonction de l’appareil de reproduction prévu. Par exemple, choisissez une résolution de 1280 x 720 pour l’iPhone et l’iPod, et une résolution de 1920 x 1080 pour l’iPad. Vous 
pouvez aussi exporter un ou plusieurs des rôles utilisés dans votre projet sous forme d’un ou de 
plusieurs fichiers appelés stems.
La destination d’exportation de fichiers inclut les réglages suivants:
• Format: formats de masterisation de listes (Vidéo et audio, Vidéo seulement, Audio seulement) 
et formats de publication (appareils Apple, Ordinateur, Hébergement web). Votre choix du 
format détermine les options proposées dans les menus locaux ci-dessous.
Important : Lors du partage d’un projet ou plan, vous ne pouvez changer de résolution que 
pour les formats de publication.
• Codec vidéo : choisissez le codec vidéo à utiliser pour le fichier exporté. (Les choix proposés 
s’appuient sur le format de média du plan ou du projet source.)
• Résolution : choisissez la résolution par défaut pour la destination. Si la destination est utilisée 
avec un projet ou un plan présentant une résolution inférieure à celle que vous avez sélectionnée, la résolution s’adapte pour se calquer sur celle du projet ou du plan.
• Formats de fichiers audio : si vous avez choisi Audio seulement dans le menu local Format, 
indiquez un format audio pour le fichier exporté. Si vous avez choisi une autre option dans le 
menu local Format, l’élément répertorie le format audio prévu pour le fichier exporté.
• Inclure les marqueurs de chapitre : cochez la case pour inclure les marqueurs de chapitre ajoutés 
au fichier de sortie du projet. Les utilisateurs peuvent ainsi passer d’un marqueur de chapitre à 
l’autre en cliquant sur le bouton Chapitre suivant ou Chapitre précédent dans iTunes ou dans 
QuickTime Player. 
• «Une fois terminé », «Ouvrir avec » ou «Ajouter à la liste de lecture »: choisissez l’opération que 
vous souhaitez voir s’exécuter une fois l’exportation terminée. Vous avez le choix d’ouvrir le 
fichier exporté dans une application, de l’ajouter à votre bibliothèque iTunes ou de le publier 
dans le navigateur multimédia. Le nom du menu local s’adapte en fonction de l’option choisie.
• Ne rien faire : choisissez cette option si vous ne voulez pas ouvrir automatiquement le 
fichier exporté.
• QuickTime Player, iTunes ou autre application : choisissez cette option pour ouvrir le fichier 
exporté dans l’application par défaut associée à ce type de fichier. Vous pouvez définir ou 
changer d’application par défaut dans le Finder. Pour en savoir plus, consultez l'aide d’OS X 
accessible depuis le menu Aide lorsque le Finder est actif.
• Compressor: cette option vous permet d’ouvrir le fichier exporté dans Compressor. Le fichier 
exporté devient alors la source d’un nouveau lot, ce qui permet de continuer plus facilement 
à traiter le film du projet. Vous pouvez, par exemple, créer les versions compressées nécessaires pour la distribution, sans passer par Final Cut Pro.
Remarque : Cette option n’est disponible que si Compressor est installé sur le même ordinateur que Final Cut Pro.
• Autre : choisissez cette option pour indiquer une autre application pour ouvrir le fichier 
exporté. Sélectionnez l’application dans la fenêtre qui s’affiche, puis cliquez sur Ouvrir.
• Bibliothèque : choisissez cette option pour ajouter le fichier exporté à votre 
bibliothèque iTunes.
• Publier sur le navigateur multimédia : cette option permet d’ajouter le fichier exporté au navigateur multimédia pour mettre le fichier de sortie à disposition de Final Cut Pro et d’autres 
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• Rôles en tant que : disponible uniquement si vous avez choisi le format de masterisation (Vidéo 
et audio, Vidéo seulement ou Audio seulement) dans le menu local Format. Si vous devez 
exporter votre projet en tant que fichiers de média séparés (par exemple, pour exporter séparément les dialogues, la musique et les effets sonores de votre projet), vous pouvez exporter 
un ou plusieurs des rôles de votre projet en tant que stems. Vous pouvez créer soit un fichier 
QuickTime multipiste combiné, soit des fichiers audio ou vidéo séparés, au moyen des rôles 
audio et vidéo de votre projet ; vous pouvez en outre attribuer une sortie mono, stéréo ou 
Surround à vos canaux audio. Pour en savoir plus sur les rôles, consultez la section Présentation 
des rôles à la page 310.
Réglages de Compressor
Utilisez cette destination pour exporter un projet ou plan en utilisant les réglages de Compressor, 
l’application professionnelle de transcodage conçue pour fonctionner directement avec 
Final Cut Pro. 
Remarque : La destination Réglages de Compressor ne s’affiche pas par défaut. Pour l’ajouter à la 
liste Destinations, consultez Utilisation de destinations à la page 447.
L’exportation d’un projet à l’aide d’un réglage de Compressor apporte de nombreux avantages 
qu’offre Compressor sans avoir à ouvrir votre projet dans cette application. Vous pouvez utiliser 
Compressor pour créer plusieurs fichiers de sortie en une seule opération de partage ou créer 
des réglages personnalisés qui modifient votre fichier de sortie, pour ajouter par exemple un 
filigrane à une vidéo. Si vous avez installé Compressor sur votre système, vous pouvez utiliser les 
réglages de Compressor avec Final Cut Pro. 
Si quelqu’un vous procure un réglage Compressor alors que l’application n’est pas installée sur 
votre système, placez le réglage à l’emplacement suivant pour que Final Cut Pro et Compressor 
puissent y accéder) : 
/Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/Compressor/Settings/.
Il se peut que vous deviez créer les dossiers Compressor et Settings (des réglages) par le biais 
du Finder. 
Conseil : Sous OS X Lion 10.7 et ultérieur, le dossier Bibliothèque au sein de votre dossier de 
départ est masqué par défaut. Vous pouvez y accéder depuis le Finder en choisissant Aller > Aller 
au dossier, puis en saisissant ~/Bibliothèque/ dans le champ Aller au dossier. Pour en savoir plus, 
consultez l'aide d’OS X accessible depuis le menu Aide lorsque le Finder est actif.
Diffusion HTTP en direct
Faites appel à cette destination pour envoyer de la vidéo et de l’audio à un iPhone, iPad, iPod 
touch ou un Mac par le biais d’un serveur web.
Remarque : La destination «Diffusion HTTP en direct » ne s’affiche pas par défaut. Pour l’ajouter à 
la liste Destinations, consultez Utilisation de destinations à la page 447.
Dans la mesure où la diffusion HTTP en direct adapte de façon dynamique la qualité de lecture 
du film au débit disponible des réseaux sans fil ou câblés, elle se révèle être un véritable atout 
lors de la diffusion de données en continu vers une application sous iOS ou un site web écrit en 
HTML5. Pour obtenir des informations détaillées sur la mise en œuvre de la diffusion HTTP en 
direct, consultez le Site web Apple relatif à la diffusion HTTP en direct dédié aux développeurs à 
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La destination «Diffusion HTTP en direct » inclut les réglages suivants:
• Versions à exporter: cochez la case pour chaque type de connexion réseau que vous comptez 
prendre en charge pour la diffusion en continu. Vous pouvez exporter des fichiers à utiliser 
avec des dispositifs exploitant une connexion cellulaire, Wi-Fi et haut débit.
Lot
Il vous est possible de regrouper des ensembles de destinations en un lot pour créer plusieurs 
types de sortie en une seule étape. Lorsque vous partagez un projet ou un plan par le biais du 
lot, un fichier pour chaque destination incluse dans le lot est automatiquement généré en sortie. 
Pour savoir comment créer un lot, consultez Utilisation de destinations à la page 447.
Utilisation de destinations
Pour modifier les destinations de partage par le biais du menu Partager, utilisez la fenêtre 
Destinations des préférences de Final Cut Pro. Vous pouvez modifier des destinations, en ajouter 
des nouvelles, en supprimer et créer des lots de destinations, ce qui vous permet d’exporter plusieurs types de sortie en une seule fois. Vous avez également la possibilité de rétablir l’ensemble 
par défaut des destinations disponibles lors de la première ouverture de Final Cut Pro. 
Pour en savoir plus sur le partage de projets et de plans depuis Final Cut Pro, consultez 
Présentation du partage de projets à la page 394.
Création d’une nouvelle destination
1 Procédez de l’une des manières suivantes:
• Choisissez Fichier > Partager > Ajouter une destination.
• Choisissez Final Cut Pro > Préférences, cliquez sur le bouton Destinations dans la partie supé-
rieure de la fenêtre, puis choisissez Ajouter une destination dans la liste Destinations qui se 
trouve à gauche.
• Sélectionnez un projet ou plan, cliquez sur le bouton Partager dans la barre d’outils, puis choisissez Ajouter une destination dans le menu local.Chapitre 16 Préférences et métadonnées 448
2 Dans la fenêtre Destinations de la fenêtre Préférences, procédez de l’une des manières suivantes:
• faites glisser une destination depuis la zone située à droite de la liste Destinations de gauche 
(ou double-cliquez sur une destination à droite).
Faites glisser une destination 
Liste Destinations dans la liste Destinations.
• Tout en maintenant la touche Contrôle enfoncée, cliquez sur une destination dans la liste 
Destinations, puis choisissez Dupliquer dans le menu contextuel.
La nouvelle destination apparaît sélectionnée dans la liste de gauche et les réglages pour la destination s’affichent à droite. 
3 Choisissez les réglages à appliquer à la nouvelle destination. 
Modifiez les réglages relatifs 
Nouvelle destination à la nouvelle destination.Chapitre 16 Préférences et métadonnées 449
Si vous avez choisi une destination web, saisissez votre nom d’utilisateur et votre mot de passe 
dans la fenêtre qui s’affiche, puis cliquez sur OK. Si vous avez coché la case « Conserver ce mot 
de passe dans mon trousseau », vos nom et mot de passe sont alors sauvegardés afin que votre 
fichier exporté puisse être téléchargé automatiquement sur le site web.
Si vous avez choisi la destination Réglages de Compressor, sélectionnez un réglage de 
Compressor dans la fenêtre qui apparaît, puis cliquez sur OK. Les réglages regroupent ceux de 
Compressor livrés avec Final Cut Pro ainsi que tous ceux que vous pouvez avoir ajoutés.
Important : Vous pouvez utiliser la destination Réglages Compressor uniquement si Compressor 
est installé ou si quelqu’un vous fournit un réglage Compressor.
Pour en savoir plus sur les réglages dechaque destination, consultez Préférences de destinations à la page 441.
Vous avez la possibilité à tout moment de double-cliquer dans la liste Destinations pour 
saisir un nouveau nom ou utiliser les commandes de droite pour modifier les réglages de 
la destination. Au fur et à mesure que vous personnalisez la destination, vos modifications 
s’enregistrent automatiquement.
Modification de destinations existantes
Remarque : Il vous est également possible de modifier les réglages d’une destination existante 
lors du partage d’un projet ou d’un plan. Pour en savoir plus, consultez Partage de projets, de 
plans et de plages à la page 395.
1 Choisissez Final Cut Pro > Préférences, puis cliquez sur Destinations.
La fenêtre Destinations s’affiche alors pour répertorier à gauche la liste des destinations.
2 Procédez de l’une des façons suivantes:
• Pour modifier les réglages d’une destination : sélectionnez une destination, puis modifiez ses 
réglages à droite.
Modifiez les réglages relatifs 
à la destination sélectionnée.
Sélectionnez une destination 
dans la liste Destinations.Chapitre 16 Préférences et métadonnées 450
• Pour rétablir les réglages d’origine d’une destination : Tout en maintenant la touche Contrôle 
enfoncée, cliquez sur une destination dans la liste Destinations, puis choisissez « Rétablir les 
réglages d’origine » dans le menu contextuel.
Les réglages de la destination reprennent alors leurs valeurs d’origine et 
s’enregistrent automatiquement.
• Pour renommer une destination :double-cliquez sur une destination dans la liste de gauche, 
puis saisissez un nouveau nom.
• Pour modifier l’ordre des destinations dans la liste : Faites glisser une destination vers un emplacement différent dans la liste Destinations.
Lorsque vous modifiez des destinations, vos modifications s’enregistrent automatiquement.
Création d’un lot de destinations
Les lots simplifient la création simultanée de plusieurs types de sortie. Un lot héberge un certain 
nombre de destinations. Lorsque vous partagez un projet ou un plan par le biais du lot, un fichier 
pour chaque destination incluse dans le lot est automatiquement généré en sortie.
1 Dans la fenêtre Destinations de la fenêtre Préférences, sélectionnez Ajouter une destination dans 
la liste Destinations, puis double-cliquez sur la destination Lot (ou faites-la glisser de la zone 
située à droite de la liste Destinations de gauche).
Un lot vide apparaît dans cette dernière liste.
2 Pour ajouter des destinations au lot, faites-y glisser les destinations existantes à partir de la liste 
Destinations, ou sélectionnez Ajouter une destination et faites glisser des destinations sur le lot 
depuis la zone située à droite.
Conseil : Pour créer rapidement un lot à partir des destinations tirées de la liste Destinations, 
sélectionnez-en une ou plusieurs dans cette dernière liste en cliquant tout en maintenant 
la touche Contrôle enfoncée, puis choisissez « Nouveau lot d’après la sélection » dans le 
menu contextuel.
Suppression d’une destination
Procédez de l’une des manières suivantes:
m Tout en maintenant la touche Contrôle enfoncée, cliquez sur une destination dans la liste 
Destinations, puis sélectionnez Supprimer dans le menu contextuel.
m Sélectionnez une destination dans la liste Destinations et appuyez sur Commande + Supprimer.
m Sélectionnez une destination dans la liste Destinations, puis cliquez sur le bouton Supprimer (–) 
sous la liste.
Indication d’une nouvelle destination par défaut
Une destination porte le nom de la destination par défaut. Elle seule peut être ouverte à l’aide 
d’un raccourci clavier (Commande + E). Lorsque vous ouvrez Final Cut Pro pour la première fois, 
la destination du fichier master est celle utilisée par défaut. Vous avez la possibilité de définir en 
toute simplicité par défaut n’importe quelle autre destination.
m Cliquez sur la destination à définir par défaut tout en maintenant la touche Contrôle enfoncée, 
puis choisissez Par défaut dans le menu contextuel.
Le nom de la nouvelle destination par défaut se voit complété du suffixe « (par défaut) ».
Rétablissement de l’ensemble par défaut de destinations fourni avec Final Cut Pro
m Cliquez dans la liste Destinations tout en maintenant la touche Contrôle enfoncée, puis choisissez « Rétablir les réglages par défaut » dans le menu contextuel.Chapitre 16 Préférences et métadonnées 451
Toutes les destinations personnalisées sont alors supprimées et l’ensemble par défaut des destinations s’affiche. Pour retrouver la liste des destinations par défaut, consultez Présentation du partage 
de projets à la page 394.
Partage de destinations entre des utilisateurs de Final Cut Pro
m Pour exporter des destinations depuis votre copie de Final Cut Pro : faites glisser dans le Finder une 
ou plusieurs destinations depuis la liste Destinations reprise dans la fenêtre des préférences de 
Final Cut Pro.
Le fichier de destination se voit complété de l’extension .fcpxdest.
m Pour importer des destinations dans votre copie de Final Cut Pro : Faites glisser un fichier de destination du Finder sur la liste Destinations.
La destination ajoutée apparaît dans la liste Destinations, le sous-menu Partager du menu Fichier et 
dans le menu local qui s’affiche lorsque vous cliquez sur le bouton Partager dans la barre d’outils.
Utilisation de métadonnées
Affichage et modification des métadonnées de plans
Les informations relatives à vos fichiers de média source, celles enregistrées par la caméra et les 
autres renseignements de description d’un plan s’appellent les métadonnées. Dans Final Cut Pro, 
vous pouvez créer vos propres associations de métadonnées à afficher avec vos plans, appelées 
présentations des métadonnées. Il vous est possible de créer des présentations des métadonnées 
ou modifier celles fournies avec Final Cut Pro.
Final Cut Pro prévoie trois types de métadonnées:
• Données EXIF (Exchangeable Image File, fichier image d’échange): renseignements que la caméra 
enregistre et stocke dans le média au moment de la prise de vue, comme la marque et le modèle 
de la caméra, la taille du fichier, le profil colorimétrique et le nombre de bits par échantillon.
• Données IPTC (International Press Telecommunications Council): données standardisées utilisées 
par les agences de presses pour intégrer des mots-clés, des légendes, des avis liés aux droits 
d’auteur et autres informations au sein même des fichiers de média.
• Métadonnées Final Cut Pro : données à appliquer aux plans dans Final Cut Pro, par exemple le 
nom des plans, leur classement et les mots-clés.
L’inspecteur d’informations vous permet d’afficher et de modifier les métadonnées pour un plan ou 
un groupe de plans sélectionné dans le navigateur d’événements ou dans la timeline. 
Bouton 
d’informationsChapitre 16 Préférences et métadonnées 452
L’inspecteur de partage affiche également les métadonnées de partage qui sont exportées avec 
un plan ou un projet partagé. Pour en savoir plus, consultez Modification des attributs de partage à la page 400.
Affichage des métadonnées d’un plan
1 Sélectionnez un plan.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur prévu sur la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui 
s’affiche.
Les métadonnées du plan ou du groupe de plans sélectionné s’affichent dans les champs de 
l’inspecteur d’informations.
Passage d’une présentation des métadonnées à l’autre dans l’inspecteur d’informations
Vous pouvez modifier les champs de métadonnées qui apparaissent dans l’inspecteur d’informations en choisissant une autre présentation de métadonnées dans le menu local prévu à cet effet.
1 Sélectionnez un plan.
2 Ouvrir l’inspecteur d’informations.
3 Choisissez une présentation de métadonnées dans le menu local prévu à cet effet.
Menu local Présentation des 
métadonnées
Remarque : Si vous créez des présentations de métadonnées personnalisées, celles-ci apparaissent également dans le menu local.
Modification des métadonnées d’un plan
1 Sélectionnez un plan.
2 Ouvrir l’inspecteur d’informations.
3 Dans le menu local Présentation des métadonnées, choisissez-en une contenant les champs 
adaptés aux métadonnées que vous souhaitez modifier.
4 Effectuez l’une des opérations suivantes:
• Cliquez sur un champ de texte pour l’activer, puis saisissez le texte à inclure.
Remarque : S’il vous est impossible de cliquer sur un champ de texte, cela signifie qu’il n’est 
pas modifiable. C’est par exemple le cas de certains champs de métadonnées EXIF.
• Choisissez dans le menu local une option adaptée aux métadonnées à modifier.
Remarque : vous pouvez également modifier la date et l’heure de la propriété « Contenu créé » 
relative à vos plans source dans le navigateur d’événements. Pour ce faire, sélectionnez simplement des plans, puis choisissez Modifier > Régler la date et l’heure de création du contenu.
Réorganisation des champs dans une présentation de métadonnées
m Dans l’inspecteur d’informations, faites glisser les étiquettes de métadonnées de sorte à établir 
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Modification de présentations de métadonnées
Il vous est possible de créer des présentations des métadonnées ou de modifier celles fournies 
avec Final Cut Pro.
Création d’une présentation de métadonnées
1 Sélectionnez un plan.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur prévu sur la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui 
s’affiche.
3 Dans l’inspecteur d’informations, choisissez une présentation de métadonnées dans le menu 
local prévu à cet effet.
4 Dans la fenêtre Présentations des métadonnées, choisissez « Nouvelle présentation des métadonnées » à partir du menu local Action situé en bas à gauche de la fenêtre.
5 Attribuez un nom à la nouvelle présentation de métadonnées et appuyez sur Retour.
6 Pour limiter le nombre de propriétés à un groupe précis, tels que les propriétés EXIF ou les propriétés vidéo, choisissez un groupe dans le menu local Propriétés, repris dans la partie supérieure 
de la fenêtre.
7 Pour ajouter une propriété à la présentation de métadonnées, cochez la case à gauche de 
la propriété.
Cochez une case pour ajouter une propriété 
à la présentation des métadonnées.
Menu local Action
8 Lorsque les champs de métadonnées attribués à la présentation de métadonnées vous 
conviennent, cliquez sur OK.
La nouvelle présentation de métadonnées est alors ajoutée au menu local prévu à cet effet dans 
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Modification d’une présentation de métadonnées
Vous avez la possibilité de modifier la combinaison de métadonnées qui apparaît dans une pré-
sentation de métadonnées. Vous pouvez renommer, ajouter ou supprimer les champs de métadonnées, en créer d’autres champs personnalisés et réorganiser l’ordre dans lequel ils s’affichent.
1 Sélectionnez un plan.
2 Ouvrir l’inspecteur d’informations.
3 Dans l’inspecteur d’informations, choisissez une présentation de métadonnées dans le menu 
local prévu à cet effet.
4 Dans la fenêtre Présentations des métadonnées, sélectionnez celle à modifier, puis effectuez l’une 
des opérations suivantes:
• Pour renommer la présentation de métadonnées: double-cliquez sur le nom de la présentation 
de métadonnées dans la colonne de gauche, attribuez-lui un nouveau nom, puis appuyez 
sur Entrée.
• Pour supprimer des propriétés (et par là même, des champs de métadonnées) de la présentation de métadonnées: dans la colonne Propriété, décochez la case en regard de la propriété 
à supprimer.
• Pour ajouter des propriétés (et donc, des champs de métadonnées) à la présentation de métadonnées: dans la colonne Propriété, cochez la case en regard de la propriété à ajouter.
• Pour ajouter une propriété personnalisée (champs de métadonnées) à la présentation de métadonnées: choisissez « Ajouter un champ de métadonnées personnalisées » dans le menu local 
Action , attribuez un nom et une description à la nouvelle propriété, puis cliquez sur OK.
5 Lorsque les champs de métadonnées sont correctement attribués à la présentation de métadonnées sélectionnée, cliquez sur OK.
Duplication d’une présentation de métadonnées
Si vous voulez créer une présentation de métadonnées contenant la plupart des champs de 
métadonnées reprises dans une présentation de métadonnées existante, il vous est possible 
d’économiser du temps en dupliquant la présentation existante puis en la modifiant.
1 Sélectionnez un plan.
2 Ouvrir l’inspecteur d’informations.
3 Dans l’inspecteur d’informations, choisissez la présentation de métadonnées à dupliquer dans 
le menu local prévu à cet effet, puis choisissez « Enregistrer la présentation des métadonnées 
sous » à partir du menu local Présentation des métadonnées.
4 Dans la fenêtre qui s’affiche en haut de la fenêtre de Final Cut Pro, attribuez un nom à la nouvelle 
présentation de métadonnées, puis cliquez sur OK.
La nouvelle présentation de métadonnées apparaît alors dans le menu local prévu à cet effet 
dans l’inspecteur d’informations. Modifiez la nouvelle présentation selon vos besoins.
Suppression d’une présentation de métadonnées
1 Sélectionnez un plan.
2 Ouvrir l’inspecteur d’informations.
3 Dans l’inspecteur d’informations, choisissez une présentation de métadonnées dans le menu 
local prévu à cet effet.
4 Dans la fenêtre Présentations des métadonnées, choisissez la présentation à supprimer dans 
la colonne de gauche, puis choisissez « Supprimer la présentation des métadonnées » dans le 
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La présentation est alors supprimée de la colonne de gauche dans la fenêtre et du menu local 
dans l’inspecteur d’informations.
Remarque : La suppression d’une présentation de ce type n’entraîne pas celle des métadonnées 
appliquées à un plan ou à son média source.
Modification de noms de plans par lot
Lorsque vous importez du média dans Final Cut Pro, les plans portent souvent des noms peu 
évocateurs, tels que ceux attribués par la caméra. Bien qu’il vous soit possible de renommer des 
plans indépendamment, vous pouvez aussi réattribution le nom d’une sélection de plans automatiquement sous forme de lot (réattribution de nom par lot) dans le navigateur d’événements, 
une fois le média importé dans Final Cut Pro. Final Cut Pro fournit des préréglages d’attribution 
de nom personnalisables pour renommer facilement des groupes conséquents de plans.
Modification de noms de plans par lot à l’aide d’un préréglage d’attribution de nom
1 Dans le navigateur d’événements, sélectionnez les plans à renommer.
2 Pour ouvrir l’inspecteur d’informations, cliquez sur le bouton Inspecteur prévu sur la barre d’outils (illustré ci-dessous), puis cliquez sur le bouton d’informations situé en haut de la fenêtre qui 
s’affiche.
3 Choisissez « Appliquer le nom personnalisé » à partir du menu local Action , puis choisissez 
un préréglage d’attribution de nom dans le sous-menu.
Les plans sélectionnés dans le navigateur d’événements sont alors renommés.
Création d’un préréglage d’attribution de nom
Dans la plupart des cas, vous serez amené à créer un préréglage d’attribution de nom et à 
le personnaliser.
Conseil : Le moyen le plus simple de créer un préréglage d’attribution de nom consiste à en 
dupliquer un existant. Reportez-vous à la tâche suivante pour en savoir plus.
1 Dans le navigateur d’événements, sélectionnez les plans à renommer.
2 Ouvrir l’inspecteur d’informations.
3 Choisissez « Appliquer le nom personnalisé » à partir du menu local Action , puis choisissez 
Nouveau dans le sous-menu.
4 Dans la fenêtre « Préréglages d’attribution de nom », double-cliquez sur Sans titre, attribuez un 
nom au nouveau préréglage et appuyez sur Retour.
Le nouveau préréglage d’attribution du nom apparaît alors dans le sous-menu « Appliquer le 
nom personnalisé » du menu local Action.
Création d’une copie d’un préréglage d’attribution de nom existant
Le moyen le plus simple de créer un préréglage d’attribution de nom consiste à dupliquer un 
préréglage existant, à savoir un préréglage contenant la plupart des options de format de nom à 
inclure, et à le modifier.
1 Dans le navigateur d’événements, sélectionnez les plans à renommer.
2 Ouvrir l’inspecteur d’informations.Chapitre 16 Préférences et métadonnées 456
3 Choisissez « Appliquer le nom personnalisé » à partir du menu local Action , puis choisissez 
Modifier dans le sous-menu.
4 Dans la fenêtre « Préréglages d’attribution de nom », maintenez la touche Contrôle enfoncée tout en cliquant sur le préréglage à dupliquer, puis choisissez Dupliquer dans le 
menu contextuel.
Le préréglage d’attribution de nom dupliqué apparaît sous celui d’origine.
5 Attribuez un nom au préréglage dupliqué et appuyez sur Retour.
Il vous est à présent possible de modifier le préréglage selon vos besoins.
Modification d’un préréglage d’attribution de nom existant
1 Dans le navigateur d’événements, sélectionnez les plans à renommer.
2 Ouvrir l’inspecteur d’informations.
3 Choisissez « Appliquer le nom personnalisé » à partir du menu local Action , puis choisissez 
Modifier dans le sous-menu.
4 Dans la fenêtre « Préréglages d’attribution de nom », ajoutez les libellés de nommage en faisant glisser les éléments des zones « Informations sur le plan », «Date/heure », « Format » et 
« Caméra » sur le champ Format.
Pour supprimer un libellé de nommage, sélectionnez-le dans le champ Format et appuyez 
sur Supprimer.
5 Réorganisez les libellés dans le champ Format en les faisant glisser.
6 Vous avez la possibilité d’ajouter des caractères entre les libellés de nommage dans ledit champ, 
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7 Lorsque le nouveau format du préréglage d’attribution de nom vous convient, cliquez sur OK.
Suppression d’un préréglage d’attribution de nom
1 Sélectionnez un plan.
2 Ouvrir l’inspecteur d’informations.
3 Choisissez « Appliquer le nom personnalisé » à partir du menu local Action , puis choisissez 
Modifier dans le sous-menu.
4 Dans la fenêtre « Préréglages d’attribution de nom », sélectionnez le préréglage à supprimer, puis 
cliquez sur le bouton Supprimer les préréglages (doté du signe moins).
Le préréglage d’attribution de nom est alors supprimé de la fenêtre « Préréglages d’attribution 
de nom ».17
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Présentation des raccourcis clavier et des gestes Multi-Touch
Final Cut Pro propose plusieurs moyens pour améliorer votre productivité lors de l’élaboration 
d’un projet :
• Raccourcis clavier standards: de nombreuses tâches courantes, telles que l’ouverture d’une 
fenêtre précise ou l’ajout d’un plan, à partir du navigateur d’événements vers la timeline, 
peuvent être accomplies très rapidement à l’aide d’une ou de plusieurs touches. Consultez la 
section Raccourcis clavier à la page 458.
• Gestes Multi-Touch : si vous possédez un trackpad ou une souris Multi-Touch, vous pouvez utiliser les gestes Multi-Touch pour effectuer rapidement de nombreuses tâches lors de la création 
d’un projet. Consultez la section Gestes Multi-Touch à la page 473.
• Raccourcis clavier personnalisés: vous pouvez créer des raccourcis supplémentaires en définissant vos propres raccourcis clavier personnalisés pour les fonctionnalités que vous utilisez souvent, telles que les commandes de réglage colorimétrique. Si vous êtes plus habitué aux raccourcis clavier d’une autre application, l’éditeur de commandes vous permet de substituer ces 
raccourcis clavier à ceux définis par défaut dans Final Cut Pro. Consultez la section Affichage 
des raccourcis clavier dans l’éditeur de commandes à la page 474.
Raccourcis clavier
Vous pouvez passer par les raccourcis clavier pour accomplir rapidement de nombreuses tâches 
dans Final Cut Pro. Pour utiliser un raccourci clavier, appuyez sur toutes les touches composant 
le raccourci. Les raccourcis relatifs aux commandes courantes sont répertoriés dans le tableau 
ci-dessous.
Application
Commande Raccourci Action
Masquer l’application Commande + H Masquer Final Cut Pro
Masquer les autres applications Commande +Option + H Masquer toutes les applications 
excepté Final Cut Pro
Personnalisation du clavier Commande +Option + K Ouvrir l’éditeur de commandes
Placer dans le Dock Commande + M Placer Final Cut Pro dans le Dock
Préférences Commande +Virgule (,) Ouvrir la fenêtre des préférences 
de Final Cut Pro
Quitter Commande +Q Quitter Final Cut Pro
Rétablir la modification Commande + Maj + Z Rétablir la dernière commande 
Annuler la modification Commande + Z Annuler la dernière commande
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Montage
Commande Raccourci Action
Ajouter au scénario E Ajouter la sélection jusqu’à la fin 
du scénario
Audition : Ajouter à l’audition Maj + Contrôle +Y Ajouter le plan sélectionné à 
l’audition
Audition : dupliquer et coller les 
effets
Commande +Option +Y Dupliquer les plans dans l’audition 
et ajouter des effets
Audition : dupliquer comme 
audition
Option +Y Créer une audition avec un plan 
de la timeline et une version dupliquée du plan, y compris les effets 
appliqués
Audition : dupliquer l’original Commande + Maj +Y Dupliquer le plan d’audition sélectionné sans les effets appliqués
Audition : remplacer et ajouter à 
l’audition
Maj +Y Créer une audition et remplacer le 
plan de la timeline par la sélection
Lame de rasoir Commande + B Couper le plan du scénario principal (ou la sélection) au niveau du 
skimmer ou de la tête de lecture
Lame de rasoir sur tout Commande + Maj + B Couper tous les plans à l’emplacement du skimmer ou de la tête 
de lecture
Scinder les éléments de plan Commande + Maj + G Diviser l’élément sélectionné en 
composants
Modifier la durée Contrôle +D Modifier la durée de la sélection
Connecter au scénario principal Q Connecter la sélection au scénario 
principal
Connecter à rebours au scénario 
principal 
Maj +Q Connecter la sélection au scénario 
principal, en alignant le point d’arrivée de la sélection sur le skimmer 
ou la tête de lecture
Copier Commande + C Copier la sélection
Créer une audition Commande +Y Créer une audition à partir de la 
sélection
Créer un scénario Commande + G Créer un scénario à partir d’une 
sélection de plans connectés
Couper Commande + X Couper la sélection
Couper et passer à l’angle 1 du 
visualiseur 
1 Couper et faire basculer le plan 
multicam sur l’angle 1 du groupe 
actuel
Couper et passer à l’angle 2 du 
visualiseur
2 Couper et faire basculer le 
plan multicam sur l’angle 2 du 
groupe actuel
Couper et passer à l’angle 3 du 
visualiseur
3 Couper et faire basculer le 
plan multicam sur l’angle 3 du 
groupe actuel
Couper et passer à l’angle 4 du 
visualiseur
4 Couper et faire basculer le 
plan multicam sur l’angle 4 du 
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Commande Raccourci Action
Couper et passer à l’angle 5 du 
visualiseur
5 Couper et faire basculer le 
plan multicam sur l’angle 5 du 
groupe actuel
Couper et passer à l’angle 6 du 
visualiseur
6 Couper et faire basculer le 
plan multicam sur l’angle 6 du 
groupe actuel
Couper et passer à l’angle 7 du 
visualiseur
7 Couper et faire basculer le plan 
multicam sur l’angle 7 du groupe 
actuel
Couper et passer à l’angle 8 du 
visualiseur
8 Couper et faire basculer le 
plan multicam sur l’angle 8 du 
groupe actuel
Couper et passer à l’angle 9 du 
visualiseur
9 Couper et faire basculer le 
plan multicam sur l’angle 9 du 
groupe actuel
Supprimer Supprimer Supprimer la sélection de la timeline, refuser la sélection du navigateur d’événements ou supprimer 
un multicam via les montages
Supprimer uniquement la 
sélection
Commande + Option + Supprimer Supprimer la sélection et joindre 
le ou les plans connectés au plan 
vide obtenu
Tout désélectionner Commande + Maj + A Désélectionner tous les éléments 
sélectionnés
Dupliquer Commande +D Dupliquer la sélection dans le navigateur d’événements
Activer/désactiver le plan V Activer ou désactiver la lecture 
pour la sélection
Développer l’audio/la vidéo Contrôle + S Afficher l’audio et la vidéo 
séparément pour tous les plans 
sélectionnés
Développer/Réduire les composants audio 
Option + Contrôle + S Développer ou réduire les composants audio pour la sélection dans 
la timeline
Étendre le montage Maj + X Étendre le point de montage sélectionné jusqu’à l’emplacement du 
skimmer ou de la tête de lecture
Étendre la sélection vers le bas Maj + Flèche vers le bas Dans le navigateur d’événements, ajouter le plan suivant à la 
sélection
Étendre la sélection vers le haut Maj + Flèche vers le haut Dans le navigateur d’événements, 
ajouter le plan précédent à la 
sélection
Finaliser l’audition Maj +Option +Y Dissoudre l’audition et la remplacer par le meilleur élément 
d’audition
Insérer W Insérer la sélection à l’emplacement du skimmer ou de la tête 
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Commande Raccourci Action
Insérer/Connecter une image figée Option + F Insérer une image figée au niveau 
de la tête de lecture ou du skimmer dans la timeline, ou connecter 
une image figée du skimmer ou 
de la tête de lecture dans l’événement à l’emplacement de la tête 
de lecture dans la timeline
Insérer un espace Option +W Insérer un plan vide à l’emplacement du skimmer ou de la tête 
de lecture
Insérer un repère d’emplacement Commande +Option +W Insérer un plan repère d’emplacement au niveau du skimmer ou 
de la tête de lecture
Prélever du scénario Commande +Option + Flèche 
haut
Prélever la sélection du scénario 
et la connecter aux plans vides 
résultants
Baisser le volume de 1 dB Contrôle +Tiret (-) Baisser le volume audio de 1 dB
Déplacer la tête de lecture Contrôle + P Déplacer la tête de lecture en saisissant une valeur de timecode
Nouveau plan composé Option + G Créer un plan composé (s’il n’y 
a pas de sélection, créer un plan 
composé vide)
Pousser la sous-image audio vers 
la gauche
Option +Virgule (,) Déplacer légèrement le point de 
montage audio d’une sous-image 
vers la gauche en créant un montage scindé
Pousser la sous-image audio vers 
la gauche de plusieurs
Maj +Option +Virgule (,) Déplacer légèrement le point de 
montage audio de 10 sous-images 
vers la gauche en créant un montage scindé
Pousser la sous-image audio vers 
la droite
Option + point (.) Déplacer légèrement le point de 
montage audio d’une sous-image 
vers la droite en créant un montage scindé
Pousser la sous-image audio vers 
la droite de plusieurs 
Maj +Option + point (.) Déplacer légèrement le point de 
montage audio de 10 sous-images 
vers la droite en créant un montage scindé
Pousser vers le bas Option + Flèche vers le bas Pousser la valeur de l’image clé 
sélectionnée vers le bas dans l’éditeur d’animation
Pousser vers la gauche Virgule (,) Déplacer légèrement la sélection 
d’une unité vers la gauche
Pousser à gauche de plusieurs Maj +Virgule (,) Déplacer légèrement la sélection 
de 10 unités vers la gauche
Pousser vers la droite Point (.) Déplacer légèrement la sélection 
d’une unité vers la droite
Pousser à droite de plusieurs Maj + point (.) Déplacer légèrement la sélection 
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Commande Raccourci Action
Pousser vers le haut Option + Flèche vers le haut Pousser la valeur de l’image clé 
sélectionnée vers le haut dans 
l’éditeur d’animation
Ouvrir une audition Y Ouvrir l’audition sélectionnée
Remplacer les connexions Accent grave (`) Remplacer temporairement 
les connexions des plans sur la 
sélection
Écraser D Écraser au niveau du skimmer ou 
de la tête de lecture
Écraser - à rebours Maj +D Écraser vers l’arrière à partir de 
l’emplacement du skimmer ou de 
la tête de lecture
Remplacer par le scénario principal Commande +Option + Flèche bas Écraser au niveau du skimmer ou 
de la tête de lecture dans le scénario principal
Coller comme élément connecté Option +V Coller la sélection et la connecter 
au scénario principal
Coller et insérer à la tête de lecture Commande +V Insérer le contenu du Pressepapiers à l’emplacement du skimmer ou de la tête de lecture
Angle précédent Maj + Contrôle + Flèche gauche Passer à l’angle précédent dans le 
plan multicam
Angle audio précédent Maj +Option + Flèche gauche Passer à l’angle audio précédent 
dans le plan multicam
Meilleur élément précédent Contrôle + Flèche gauche Sélectionner le plan précédent 
dans la fenêtre Audition pour le 
choisir comme le meilleur
Angle vidéo précédent Commande + Maj + Flèche gauche Revenir à l’angle vidéo précédent 
dans le plan multicam
Augmenter le volume de 1 dB Contrôle + Égal (=) Augmenter le volume audio 
de 1 dB
Remplacer Maj + R Remplacer le plan sélectionné de 
la timeline par la sélection du navigateur d’événements
Remplacer depuis le début Option + R Remplacer le plan sélectionné de 
la timeline par la sélection du navigateur d’événements, à partir de 
son point de départ
Remplacer par un vide Maj + Supprimer Remplacer le plan sélectionné de 
la timeline par un plan vide
Tout sélectionner Commande + A Sélectionner tous les plans
Sélectionner le plan C Sélectionner le plan sous le pointeur de la timeline
Sélectionner le bord audio gauche Maj + crochet ouvrant ([) Pour les plans audio/vidéo dans la 
présentation étendue, sélectionner 
le bord gauche du point de montage audio
Sélectionner le bord gauche Crochet ouvrant ([) Sélectionner le bord gauche du 
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Commande Raccourci Action
Sélectionner les bords de montage 
audio gauche et droit
Maj + barre oblique inverse (\) Pour les plans audio/vidéo dans la 
présentation étendue, sélectionner 
les bords gauche et droit du point 
de montage audio
Sélectionner les bords de montage 
gauche et droit
Barre oblique inverse (\) Sélectionner les bords gauche et 
droit du point de montage
Sélectionner l’angle suivant Maj + Contrôle + Flèche droite Passer à l’angle suivant dans le 
plan multicam
Sélectionner l’angle audio suivant Maj +Option + Flèche droite Passer à l’angle audio suivant dans 
le plan multicam
Sélectionner la meilleure image 
suivante
Contrôle + Flèche droite Sélectionner le prochain plan dans 
la fenêtre Audition pour le choisir 
comme le meilleur
Sélectionner l’angle vidéo suivant Commande + Maj + Flèche droite Passer à l’angle vidéo suivant dans 
le plan multicam
Sélectionner le bord audio droit Maj + crochet fermant (]) Pour les plans audio/vidéo dans 
la présentation étendue, sélectionner le bord droit du point de 
montage audio
Sélectionner le bord droit Crochet fermant (]) Sélectionner le bord droit du point 
de montage
Définir une fin de sélection 
supplémentaire
Commande + Maj +O Définition d’un point d’arrivée de 
sélection de plage supplémentaire 
au niveau de la tête de lecture ou 
du skimmer
Définir un début de sélection 
supplémentaire
Commande + Maj + I Définition d’un point de départ de 
sélection de plage supplémentaire 
au niveau de la tête de lecture ou 
du skimmer
Afficher/Masquer l’éditeur de 
précision
Contrôle + E Lorsqu’un point de montage est 
sélectionné, afficher ou masquer 
l’éditeur de précision
Magnétisme N Activer ou désactiver la fonction 
d’alignement automatique
Solo Option + S Lire en solo les éléments sélectionnés dans la timeline
Média source : audio et vidéo Maj + 1 Activer le mode audio/vidéo pour 
ajouter à la timeline les sections 
audio et vidéo de la sélection
Média source : audio seulement Maj + 3 Activer le mode audio uniquement 
pour ajouter à la timeline la section audio de la sélection
Média source : vidéo uniquement Maj + 2 Activer le mode vidéo uniquement pour ajouter à la timeline la 
section audio de la sélection à la 
timeline
Passer à l’angle 1 du visualiseur Option + 1 Faire basculer le plan multicam sur 
l’angle 1 du groupe actuel
Passer à l’angle 2 du visualiseur Option + 2 Faire basculer le plan multicam sur 
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Commande Raccourci Action
Passer à l’angle 3 du visualiseur Option + 3 Faire basculer le plan multicam sur 
l’angle 3 du groupe actuel
Passer à l’angle 4 du visualiseur Option + 4 Faire basculer le plan multicam sur 
l’angle 4 du groupe actuel
Passer à l’angle 5 du visualiseur Option + 5 Faire basculer le plan multicam sur 
l’angle 5 du groupe actuel
Passer à l’angle 6 du visualiseur Option + 6 Faire basculer le plan multicam sur 
l’angle 6 du groupe actuel
Passer à l’angle 7 du visualiseur Option + 7 Faire basculer le plan multicam sur 
l’angle 7 du groupe actuel
Passer à l’angle 8 du visualiseur Option + 8 Faire basculer le plan multicam sur 
l’angle 8 du groupe actuel
Passer à l’angle 9 du visualiseur Option + 9 Faire basculer le plan multicam sur 
l’angle 9 du groupe actuel
Activer/Désactiver le mode 
Scénario
G Activer ou désactiver la possibilité d’élaborer des scénarios lors 
du déplacement des plans sur la 
timeline
Appliquer un trim à la fin Option + crochet fermant (]) Appliquer un trim à la fin du plan 
sélectionné ou du premier plan à 
l’emplacement du skimmer ou de 
la tête de lecture 
Appliquer un trim sur le début Option + crochet ouvrant ([) Appliquer un trim au point de 
départ du plan à l’emplacement 
du skimmer ou de la tête de 
lecture 
Ajuster à la sélection Option + barre oblique inverse (\) Appliquer un trim aux points de 
départ et d’arrivée de la plage 
sélectionnée du plan
Effets
Commande Raccourci Action
Ajouter un tiers inférieur standard Maj + Contrôle +T Connecter un tiers inférieur standard au scénario principal
Ajouter un titre standard Contrôle +T Connecter un titre standard au 
scénario principal
Ajouter une transition par défaut Commande +T Ajouter la transition par défaut à la 
sélection
Réglage colorimétrique : réinitialiser les commandes actives
Option + Supprimer Réinitialiser toutes les commandes 
dans la fenêtre active du réglage 
colorimétrique
Réglage colorimétrique : activer la 
fenêtre Couleur
Commande + Contrôle + C Activer la fenêtre Couleur du 
réglage colorimétrique
Réglage colorimétrique : activer la 
fenêtre Exposition
Commande + Contrôle + E Activer la fenêtre Exposition du 
réglage colorimétrique
Réglage colorimétrique : activer la 
fenêtre Saturation
Commande + Contrôle + S Activer la fenêtre Saturation du 
réglage colorimétriqueChapitre 17 Raccourcis clavier et gestes 465
Commande Raccourci Action
Copier les effets Commande +Option + C Copier les effets sélectionnés et 
leurs réglages
Activer/Désactiver la balance des 
couleurs
Commande +Option + B Activer ou désactiver l’étalonnage 
de balance
Reprendre l’audio Commande + Maj + M Correspondance du son entre 
les plans
Respecter les couleurs Commande +Option + M Correspondance des couleurs 
entre les plans
Texte suivant Option +Tab Passer à l’élément de texte suivant
Coller les attributs Commande + Maj +V Coller les attributs sélectionnés et 
leurs réglages à la sélection
Coller les effets Commande +Option +V Coller les effets et leurs réglages à 
la sélection
Texte précédent Maj +Option +Tab Passer à l’élément de texte 
précédent
Éditeur de resynchronisation Commande + R Afficher ou masquer l’éditeur de 
synchronisation
Resynchronisation : créer un segment à vitesse normale
Maj + N Régler la sélection pour être lue à 
vitesse normale (100 %)
Resynchronisation : suspendre Maj + H Créer un segment « de suspension » de 2 secondes
Resynchronisation : réinitialiser Commande +Option + R Réinitialiser la sélection pour être 
lue à vitesse normale (100 %)
Solo de l’animation Maj + Contrôle +V Afficher un effet à la fois dans l’éditeur d’animation vidéo
Générales
Commande Raccourci Action
Supprimer Supprimer Supprimer la sélection de la timeline, refuser la sélection du navigateur d’événements ou supprimer 
un multicam via les montages
Rechercher Commande + F Afficher ou masquer la fenêtre 
Filtre (dans le navigateur d’événements) ou l’index de la timeline
Aller au visualiseur d’événements Commande +Option + 3 Activer le visualiseur d’événements
Importer des médias Commande + I Importer des médias depuis 
un appareil, une caméra ou 
une archive
Placer dans la Corbeille Commande + Supprimer Placer la sélection dans la Corbeille 
du Finder
Nouveau projet Commande + N Création d’un projet
Propriétés du projet Commande + J Ouvrir l’inspecteur de propriétés 
du projet actif
Effectuer le rendu de tout Maj + Contrôle + R Lancer toutes les tâches de rendu 
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Commande Raccourci Action
Effectuer le rendu de la sélection Contrôle + R Démarrer les tâches de rendu pour 
la sélection
Afficher dans le Finder Commande + Maj + R Afficher le fichier média source 
du plan d’événement sélectionné 
dans le Finder
Marquage
Commande Raccourci Action
Ajouter un marqueur M Ajouter un marqueur au niveau du 
skimmer ou de la tête de lecture
Ajouter un marqueur et modifier Option + M Ajouter un marqueur et modifier le 
texte du marqueur
Appliquer la balise de mot-clé 1 Contrôle + 1 Appliquer le mot-clé 1 à la 
sélection
Appliquer la balise de mot-clé 2 Contrôle + 2 Appliquer le mot-clé 2 à la 
sélection
Appliquer la balise de mot-clé 3 Contrôle + 3 Appliquer le mot-clé 3 à la 
sélection
Appliquer la balise de mot-clé 4 Contrôle + 4 Appliquer le mot-clé 4 à la 
sélection
Appliquer la balise de mot-clé 5 Contrôle + 5 Appliquer le mot-clé 5 à la 
sélection
Appliquer la balise de mot-clé 6 Contrôle + 6 Appliquer le mot-clé 6 à la 
sélection
Appliquer la balise de mot-clé 7 Contrôle + 7 Appliquer le mot-clé 7 à la 
sélection
Appliquer la balise de mot-clé 8 Contrôle + 8 Appliquer le mot-clé 8 à la 
sélection
Appliquer la balise de mot-clé 9 Contrôle + 9 Appliquer le mot-clé 9 à la 
sélection
Effacer les plages sélectionnées Option + X Annuler la plage sélectionnée
Effacer la fin de la plage Option +O Effacer le point d’arrivée de 
la plage
Effacer le début de la plage Option + I Effacer le point de départ de 
la plage
Supprimer le marqueur Contrôle + M Supprimer le marqueur 
sélectionné
Supprimer les marqueurs dans la 
sélection
Maj + Contrôle + M Supprimer tous les marqueurs de 
la sélection
Tout désélectionner Commande + Maj + A Désélectionner tous les éléments 
sélectionnés
Favori F Classer la sélection du navigateur 
d’événements comme favori 
Nouvelle collection de mots-clés Commande + Maj + K Créer une collection de mots-clés
Nouvelle collection intelligente Commande +Option + N Créer une collection intelligente
Outil Sélection de plage R Activer l’outil Sélection par plageChapitre 17 Raccourcis clavier et gestes 467
Commande Raccourci Action
Supprimer tous les mots-clés de la 
sélection
Contrôle + 0 Supprimer tous les mots-clés 
de la sélection du navigateur 
d’événements
Rôles: Appliquer le rôle Dialogue Option + Contrôle +D Appliquer le rôle Dialogue au plan 
sélectionné
Rôles: Appliquer le rôle Effets Option + Contrôle + E Appliquer le rôle Effets au plan 
sélectionné
Rôles: Appliquer le rôle Musique Option + Contrôle + M Appliquer le rôle Musique au plan 
sélectionné
Rôles: Appliquer le rôle Titres Option + Contrôle +T Appliquer le rôle Titres au plan 
sélectionné
Rôles: appliquer le rôle Vidéo Option + Contrôle +V Appliquer le rôle Vidéo au plan 
sélectionné
Tout sélectionner Commande + A Sélectionner tous les plans
Sélectionner la plage de plans X Définir la sélection de plage pour 
correspondre aux bordures du 
plan sous le skimmer ou la tête de 
lecture
Définir une fin de plage 
supplémentaire
Commande + Maj +O Définition d’un point d’arrivée de 
sélection de plage supplémentaire 
au niveau de la tête de lecture ou 
du skimmer
Définir un début de plage 
supplémentaire
Commande + Maj + I Définition d’un point de départ de 
sélection de plage supplémentaire 
au niveau de la tête de lecture ou 
du skimmer
Définir la fin de la plage O Définir le point d’arrivée pour la 
plage
Définir la fin de la plage Contrôle +O Définir le point d’arrivée pour la 
plage tout en modifiant un champ 
de texte
Définir le début de la plage I Définir le point de départ pour la 
plage
Définir le début de la plage Contrôle + I Définir le point de départ pour la 
plage tout en modifiant un champ 
de texte
Déclasser U Supprimer les classements de la 
sélection
Organisation
Commande Raccourci Action
Nouvel événement Option + N Créer un événement
Nouveau dossier Commande + Maj + N Créer un dossier
Afficher dans le navigateur 
d’événements
Maj + F Afficher le plan sélectionné dans le 
navigateur d’événements
Synchroniser les plans Commande +Option + G Synchroniser les plans d’événements sélectionnésChapitre 17 Raccourcis clavier et gestes 468
Lecture/Navigation
Commande Raccourci Action
Audio lors du survol Maj + S Activer et désactiver l’audio lors 
du survol
Audition : preview Commande + Contrôle +Y Lire le meilleur élément en 
contexte dans la timeline
Survol de plan Commande + Option + S Activer ou désactiver le survol 
de plan
Couper/Activer l’audio multicam 
uniquement
Maj +Option + 3 Activer le mode audio uniquement 
pour la découpe et le basculement 
multicam
Couper/Activer l’audio et la vidéo 
multicam
Maj +Option + 1 Activer le mode audio/vidéo pour 
la découpe et le basculement 
multicam
Couper/Activer la vidéo multicam 
uniquement
Maj +Option + 2 Activer le mode vidéo uniquement 
pour la découpe et le basculement 
multicam
Vers le bas Flèche vers le bas Passer à l’élément (dans le navigateur d’événements) ou au point de 
montage (dans la timeline) suivant
Vers le bas Contrôle + Flèche bas Lors de la modification d’un 
champ de texte, passer à l’élément 
suivant (dans le navigateur d’évé-
nements) ou au point de montage 
suivant (dans la timeline).
Reculer de 10 images Maj + Flèche gauche Reculer la tête de lecture de 
10 images
Avancer de 10 images Maj + Flèche droite Avancer la tête de lecture de 
10 images
Aller au début Bouton Début Déplacer la tête de lecture au 
début de la timeline ou au premier plan dans le navigateur 
d’événements
Aller au groupe suivant Maj +Option + Apostrophe (’) Afficher le groupe d’angles suivant 
dans le plan multicam ouvert
Aller au montage suivant Apostrophe (’) Déplacer la tête de lecture au 
point de montage suivant dans la 
timeline
Aller à la trame suivante Option + Flèche droite Avancer la tête de lecture à la 
trame suivante d’un plan entrelacé
Avancer d’une image Flèche droite Avancer la tête de lecture sur 
l’image suivante
Passer à la sous-image suivante Commande + Flèche droite Avancer la tête de lecture sur la 
sous-image audio suivante
Revenir au groupe précédent Maj +Option + Point-virgule (;) Afficher le groupe d’angles précé-
dent dans le plan multicam ouvert
Aller au montage précédent Point-virgule (;) Reculer la tête de lecture sur le 
point de montage précédent dans 
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Commande Raccourci Action
Reculer d’une trame Option + Flèche gauche Reculer la tête de lecture à la 
trame précédente d’un plan 
entrelacé
Reculer d’une image Flèche gauche Reculer la tête de lecture sur 
l’image précédente
Revenir à la sous-image 
précédente
Commande + Flèche gauche Reculer la tête de lecture sur la 
sous-image audio précédente
Aller à la fin de la plage Maj +O Déplacer la tête de lecture à la fin 
de la sélection par plage
Aller au début de la plage Maj + I Déplacer la tête de lecture au 
début de la plage de sélection
Lecture en boucle Commande + L Activer ou désactiver la lecture en 
boucle
Contrôler l’audio Maj + A Activer ou désactiver le contrôle 
audio pour l’angle ignoré
Entrée de timecode négative Tiret (-) Saisir une valeur négative de timecode pour déplacer la tête de lecture vers l’arrière, déplacer un plan 
en arrière ou appliquer un trim sur 
une plage ou un plan, en fonction 
de la sélection opérée
Plan suivant Commande + Contrôle + Flèche 
droite
Passer à l’élément (dans le navigateur d’événements) ou au point de 
montage (dans la timeline) suivant
Marqueur suivant Contrôle + Apostrophe (’) Avancer la tête de lecture sur le 
marqueur suivant
Lire le contexte Maj + point d’interrogation (?) Lire autour de l’emplacement de la 
tête de lecture
Lecture rapide L Lecture (appuyer plusieurs fois sur 
L pour augmenter la vitesse de 
lecture)
Lecture rapide Contrôle + L Lire lors de la modification d’un 
champ de texte (appuyer plusieurs fois sur L pour augmenter la 
vitesse de lecture)
Lire depuis la tête de lecture Option + barre d’espace Lire à partir de la tête de lecture
Lire en plein écran Commande + Maj + F Lire en plein écran à partir du 
skimmer ou de la tête de lecture
Lecture arrière J Lire en arrière (appuyer plusieurs 
fois sur J pour augmenter la vitesse 
de lecture)
Lecture arrière Contrôle + J Lire en arrière lors de la modification d’un champ de texte (appuyer 
plusieurs fois sur J pour augmenter 
la vitesse de lecture)
Lecture arrière Maj + barre d’espace Lire en arrière
Lire la sélection Barre oblique (/) Lire la sélection
Lire jusqu’à la fin Maj + Contrôle +O Lire à partir de la tête de lecture 
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Commande Raccourci Action
Lecture/Pause Barre d’espace Lancer ou arrêter la lecture
Lecture/Pause Contrôle + Barre d’espace Lancer ou mettre en pause lors 
de la modification d’un champ de 
texte
Entrée de timecode positive Égal (=) Saisir une valeur positive de timecode pour déplacer la tête de lecture vers l’avant, déplacer un plan 
en avant ou appliquer un trim sur 
une plage ou un plan, en fonction 
de la sélection opérée
Plan précédent Commande + Contrôle + Flèche 
gauche
Revenir à l’élément (dans le navigateur d’événements) ou au point 
de montage (dans la timeline) 
précédent
Marqueur précédent Contrôle + Point-virgule (;) Reculer la tête de lecture sur le 
marqueur précédent
Définir l’angle de contrôle Maj +V Définir l’angle ignoré comme 
angle de contrôle
Survol S Activer ou désactiver le survol
Arrêter K Arrêter la lecture
Arrêter Contrôle + K Arrêter la lecture lors de la modification d’un champ de texte
Reculer dans l’historique de la 
timeline
Commande + Crochet ouvrant ([) Revenir en arrière d’un niveau 
dans l’historique de la timeline
Avancer dans l’historique de la 
timeline
Commande + Crochet fermant (]) Avancer d’un niveau dans l’historique de la timeline
Vers le haut Flèche vers le haut Revenir à l’élément (dans le navigateur d’événements) ou au point 
de montage (dans la timeline) 
précédent
Vers le haut Contrôle + Flèche haut Lors de la modification d’un 
champ de texte, revenir à l’élément 
(dans le navigateur d’événements) 
ou au point de montage (dans la 
timeline) précédent
Partage et outils
Commande Raccourci Action
Partager la destination par défaut Commande + E Partager le projet ou plan sélectionné à l’aide de la destination 
par défaut
Outil de sélection (représenté par 
la flèche)
A Activer l’outil de sélection
Outil Lame de rasoir B Activer l’outil Lame de rasoir
Outil Rognage Maj + C Activer l’outil Rogner et afficher les 
commandes à l’écran pour le plan 
sélectionné ou celui au niveau de 
la tête de lecture et se trouvant au 
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Commande Raccourci Action
Outil Distorsion Commande + Maj +D Activer l’outil Distorsion et afficher 
les commandes à l’écran pour 
le plan sélectionné ou celui au 
niveau de la tête de lecture et se 
trouvant au premier plan
Outil Main H Activer l’outil Main
Outil Position P Activer l’outil Position
Outil Transformation Maj +T Activer l’outil Transformation et 
afficher les commandes à l’écran 
pour le plan sélectionné ou celui 
au niveau de la tête de lecture et 
se trouvant au premier plan
Outil Trim T Activer l’outil Trim
Outil Zoom Z Activer l’outil Zoom
Présentation
Commande Raccourci Action
Apparence du plan : Étiquettes de 
plan uniquement
Option + Contrôle + 6 En fonction du réglage relatif au 
nom du plan, affiche les plans de 
la timeline avec leur nom, leur rôle 
ou leur angle actif.
Apparence du plan : Réduction de 
la taille de la forme d'onde
Option + Contrôle + Flèche vers 
le bas
Réduction de la taille des formes 
d'onde audio pour les plans de la 
timeline
Apparence du plan : Pellicules 
uniquement
Option + Contrôle + 5 Afficher uniquement les plans 
de la timeline avec des grandes 
pellicules
Apparence du plan : Augmentation 
de la taille de la forme d'onde
Option + Contrôle + Flèche vers 
le haut
Augmentation de la taille des 
formes d'onde audio pour les 
plans de la timeline
Apparence du plan : Grandes 
pellicules
Option + Contrôle + 4 Afficher les plans de la timeline 
avec de petites formes d'onde 
audio et de grandes pellicules
Apparence du plan : Grandes 
formes d'onde
Option + Contrôle + 2 Afficher les plans de la timeline 
avec de grandes formes d'onde 
audio et de petites pellicules
Apparence du plan : Formes 
d'onde et pellicules
Option + Contrôle + 3 Afficher les plans de la timeline 
avec des grandes formes d'onde 
audio et des pellicules vidéo de 
même taille
Apparence du plan : Formes 
d'onde uniquement
Option + Contrôle + 1 Afficher uniquement les plans de la 
timeline avec des grandes formes 
d'onde audio
Réduire la hauteur du plan Commande + Maj +Tiret (-) Réduire la hauteur de plan dans le 
navigateur d’événements
Augmenter la hauteur du plan Commande + Maj + Égal (=) Augmenter la hauteur de plan du 
navigateur d’événements
Afficher un nombre moindre 
d’images de la pellicule 
Commande + Maj +Virgule (,) Afficher un nombre moindre 
d’images de la pellicule dans les 
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Commande Raccourci Action
Afficher/Masquer l’animation audio Contrôle + A Afficher ou masquer l’éditeur 
d’animation audio pour les plans 
sélectionnés
Afficher/Masquer les informations 
du skimmer
Contrôle +Y Afficher ou masquer les informations du plan lors du survol dans le 
navigateur d’événements
Afficher/Masquer l’animation vidéo Contrôle +V Afficher ou masquer l’éditeur 
d’animation vidéo pour les plans 
sélectionnés de la timeline
Afficher un nombre supérieur 
d’images de la pellicule
Commande + Maj + Point (.) Afficher un nombre supérieur 
d’images de la pellicule dans les 
plans du navigateur d’événements
Afficher une image par pellicule Commande + Maj +Option +Vir
gule (,)
Afficher une image par pellicule
Afficher le nom des plans Maj +Option + N Afficher ou masquer les noms 
des plans dans le navigateur 
d’événements.
Afficher le navigateur d’événements sous forme de pellicule
Commande +Option + 1 Activer la présentation en pellicule 
du navigateur d’événements
Afficher le navigateur d’événements en liste
Commande +Option + 2 Activer la présentation par liste du 
navigateur d’événements
Zoom avant Commande + Égal (=) Réaliser un zoom avant sur la timeline, le navigateur d’événements 
ou le visualiseur
Zoom arrière Commande +Tiret (-) Réaliser un zoom arrière de la 
timeline, du navigateur d’événements ou du visualiseur
Zoom pour adapter à la fenêtre Maj + Z Redimensionner le contenu pour 
l’adapter à la taille du navigateur 
d’événements, au visualiseur ou à 
la timeline
Zoom sur les échantillons Contrôle + Z Activer ou désactiver le zoom sur 
les échantillons audio
Fenêtres
Commande Raccourci Action
Tâches d’arrière-plan Commande + 9 Afficher ou masquer la fenêtre de 
tâches d’arrière-plan
Aller aux améliorations audio Commande + 8 Afficher l’inspecteur d’améliorations audio
Accéder au réglage colorimétrique Commande + 6 Activer le réglage colorimétrique
Aller au navigateur d’événements Commande + 1 Activer le navigateur 
d’événements
Aller à l’inspecteur Commande +Option + 4 Activer l’inspecteur sélectionné
Aller à la timeline Commande + 2 Activer la timeline
Aller au visualiseur Commande + 3 Activer le visualiseur
Onglet suivant Contrôle +Tabulation Aller à la fenêtre suivante 
dans l’inspecteur et le réglage 
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Commande Raccourci Action
Onglet précédent Maj + Contrôle +Tabulation Revenir à la fenêtre précédente 
dans l’inspecteur ou le réglage 
colorimétrique
Afficher l’histogramme Commande + Contrôle + H Afficher l’histogramme dans le 
visualiseur
Afficher le vecteurscope Commande + Contrôle +V Afficher le vecteurscope dans le 
visualiseur
Afficher les formes d’onde vidéo Commande + Contrôle +W Afficher le moniteur de formes 
d’ondes dans le visualiseur
Afficher/Masquer les angles Commande + Maj + 7 Afficher/Masquer le visualiseur 
d’angle
Afficher/Masquer les VU-mètres 
audio
Commande + Maj + 8 Afficher ou masquer les VU-mètres 
audio
Afficher/Masquer le navigateur 
d’effets
Commande + 5 Afficher ou masquer le navigateur 
d’effets
Afficher/Masquer la bibliothèque 
d’événements
Commande + Maj + 1 Afficher ou masquer la bibliothèque d’événements
Afficher/Masquer le visualiseur 
d’événements
Commande + Contrôle + 3 Afficher ou masquer le visualiseur 
d’événements 
Afficher/masquer l’inspecteur Commande + 4 Afficher ou masquer la fenêtre 
Inspecteur
Afficher/Masquer l’éditeur de 
mots-clés
Commande + K Afficher ou masquer l’éditeur de 
mots-clés
Afficher/Masquer la bibliothèque 
de projets 
Commande + 0 Afficher ou masquer la bibliothèque de projets
Afficher/Masquer l’index de la 
timeline
Commande + Maj + 2 Afficher ou masquer l’index de la 
timeline pour le projet ouvert
Afficher/Masquer les instruments 
vidéo
Commande + 7 Afficher ou masquer les instruments vidéo dans le visualiseur
Gestes Multi-Touch
Si votre ordinateur est équipé d’un trackpad Multi-Touch, vous pouvez recourir à des gestes 
Multi-Touch repris dans le tableau ci-dessous lorsque vous travaillez dans Final Cut Pro.
Pour en savoir plus sur les gestes Multi-Touch, consultez la documentation fournie avec 
votre ordinateur.
Geste Action
Défilement (à l’aide de deux doigts): déplace le point actif sur la timeline 
verticalement ou horizontalement. 
Défilement (à l’aide de trois doigts): effectuez un balayage vers le haut pour 
déplacer la tête de lecture au début de la timeline. À l’inverse, un balayage 
vers le bas positionne la tête de lecture à la fin de la timeline. Réalisez un 
balayage horizontal pour déplacer la tête de lecture à gauche ou à droite.Chapitre 17 Raccourcis clavier et gestes 474
Personnalisation des raccourcis clavier
Affichage des raccourcis clavier dans l’éditeur de commandes
Final Cut Pro met à votre disposition une multitude de commandes de menus et de raccourcis 
clavier qui vous permettent de contrôler les moindres aspects de votre projet, de la lecture à 
l’affichage des fenêtres et des inspecteurs, en passant par l’utilisation d’outils. L’éditeur de commandes vous permet de modifier des raccourcis, d’en créer d’autres et d’enregistrer plusieurs 
ensembles de raccourcis clavier qu’il est possible d’exporter pour les transmettre à autrui. Vous 
pouvez à l’inverse importer un ensemble de raccourcis qu’un autre utilisateur aura créé. Si vous 
êtes en outre plus habitué aux raccourcis clavier d’autres applications, l’éditeur de commandes 
vous permet de substituer ces raccourcis clavier à ceux définis par défaut pour Final Cut Pro.
L’éditeur de commandes propose un certain nombre raccourcis clavier pour Final Cut Pro en 
anglais, en japonais, en français et en allemand. Le système d’exploitation de votre ordinateur détermine la langue d’affichage. Pour apprendre comment modifier la langue utilisée par 
Final Cut Pro, voir l'aide d'OS X, disponible dans le menu Aide si le Finder est actif.
Affichage des raccourcis clavier
1 Choisissez Final Cut Pro > Commandes > Personnaliser (ou appuyez sur 
Commande +Option + K). 
L’éditeur de commandes s’affiche alors.
2 Pour rechercher des raccourcis clavier dans l’éditeur de commandes, effectuez l’une des opérations suivantes:
• Cliquez sur une ou plusieurs touches représentées sur le clavier virtuel (ou sur l’un des quatre 
boutons correspondant aux touches de modification en haut de l’éditeur de commandes).Chapitre 17 Raccourcis clavier et gestes 475
Les groupes de commandes associés à la ou aux touches sélectionnées apparaissent dans le 
coin inférieur gauche de la fenêtre, tandis qu’une liste répertorie tous les raccourcis claviers 
qui y sont associés dans la partie inférieure droite de la fenêtre. 
Sélectionnez une touche pour afficher les 
groupes de commandes associés à celle-ci.
Si vous maintenez une touche de modification quelconque du clavier, les couleurs des touches 
s’actualisent. Les couleurs de touches correspondent aux classifications des commandes, par 
exemple les commandes de lecture telles que Lecture/Pause (barre d’espace) sont bleues. La 
zone Groupes de commandes qui s’affiche à gauche de la liste des commandes reprend en 
outre une touche de couleur sur lequel vous pouvez cliquer à des fins de référence.
• Saisissez le nom d’une commande, des mots-clés la décrivant ou le nom d’une touche dans le 
champ de recherche situé en haut à droite de la fenêtre.
Les commandes correspondant au terme de recherche sont alors répertoriées dans la liste des 
commandes placée en bas de la fenêtre.
Conseil : Pour afficher les touches qui correspondent aux éléments de la liste des commandes, cliquez sur le bouton de mise en surbrillance du clavier repris à gauche du champ 
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Cliquez sur une commande dans la liste pour retrouver ses détails dans la zone «Détail de la 
commande » située dans le coin inférieur droit de la fenêtre. 
Commandes trouvées 
par la recherche
Saisissez un terme à 
rechercher ici.
• Cliquez sur un groupe de commandes pour filtrer rapidement la liste de commandes et n’afficher que les commandes et les raccourcis clavier de ce groupe.
Cliquez sur une commande dans la liste pour retrouver ses détails dans la zone «Détail de la 
commande » située dans le coin inférieur droit de la fenêtre. 
Cliquez sur un groupe de commandes pour 
filtrer rapidement la liste de commandes.
Affichage des raccourcis issus d’un autre ensemble de commandes
Si votre système prévoit plusieurs ensembles de commandes, vous pouvez facilement basculer 
de l’un à l’autre. Pour en savoir plus, consultez Exportation et importation d’ensembles de raccourcis dans l’éditeur de commandes à la page 478.
Procédez de l’une des manières suivantes:
m Choisissez Final Cut Pro > Commandes, puis choisissez dans le sous-menu un ensemble 
de commandes.
La fenêtre de l’éditeur de commandes affiche alors l’ensemble indiqué.Chapitre 17 Raccourcis clavier et gestes 477
m Si l’éditeur de commandes est déjà ouvert, choisissez un ensemble de commandes dans le menu 
local situé dans le coin supérieur gauche de la fenêtre.
Les ensembles de 
commandes sont 
répertoriés en bas 
du menu local.
Modification des raccourcis clavier dans l’éditeur de commandes
Vous avez la possibilité de personnaliser en toute simplicité les raccourcis clavier repris dans l’éditeur de commandes. Si vous comptez ajouter quelques commandes personnalisées à l’ensemble 
par défaut de Final Cut Pro, il vous est possible de créer une copie de ce dernier et d’affecter 
des raccourcis clavier à certaines des commandes non affectées. Vous pouvez aussi créer un 
ensemble se limitant à vos commandes.
Duplication d’un ensemble de commandes
1 Choisissez Final Cut Pro > Commandes > Personnaliser (ou appuyez sur 
Commande +Option + K).
2 Si l’ensemble de commandes à dupliquer ne se trouve pas à l’écran, choisissez un autre 
ensemble dans le menu local situé dans le coin supérieur gauche de l’éditeur de commandes.
3 Choisissez Dupliquer dans le menu local.
4 Dans la fenêtre qui s’affiche, attribuez un nom à l’ensemble de commandes, puis cliquez sur OK.
Le nouvel ensemble dupliqué est alors ajouté au sous-menu Commandes du menu de 
Final Cut Pro et au menu local prévu dans l’éditeur de commandes.
Modification d’un ensemble de commandes
Il vous est possible d’ajouter des raccourcis clavier à un ensemble de commandes ou d’en 
réattribuer certains.
1 Choisissez Final Cut Pro > Commandes > Personnaliser (ou appuyez sur 
Commande +Option + K).
2 Si l’ensemble de commandes à modifier ne se trouve pas à l’écran, sélectionnez un autre 
ensemble dans le menu local situé dans la partie supérieure de l’éditeur de commandes.
3 Sélectionnez la commande à laquelle vous voulez attribuer le nouveau raccourci clavier en procédant de l’une des manières suivantes:
• Saisissez le nom d’une commande dans le champ de recherche prévu en haut à droite de la 
fenêtre de l’éditeur de commandes.
• Parcourez la liste de commandes jusqu’à retrouver celle de votre choix.
4 Appuyez sur combinaison de touches à attribuer à la commande (par exemple, Maj +Option +T 
ou toute autre touche).
Remarque : Les touches estompées et barrées sur le clavier virtuel de l’éditeur de commandes sont réservées par le système pour son usage propre et ne peuvent dans ce cas pas 
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Si cette combinaison de touches n’est associée à aucune commande, le clavier virtuel s’actualise 
pour refléter le nouveau raccourci assigné. Un point gris apparaît sur la ou les touches affectées 
et une couleur se voit appliquée à la commande si elle fait partie d’un groupe de commandes 
noté par un code de couleur.
Si cette combinaison de touches est déjà associée à une commande, Final Cut Pro affiche le 
réglage actif et vous invite à confirmer sa modification.
5 Pour enregistrer les modifications apportées à l’ensemble de commandes, cliquez sur le bouton 
Enregistrer dans le coin inférieur droit de l’éditeur de commandes.
Si vous fermez l’éditeur de commandes sans avoir enregistré vos modifications, Final Cut Pro 
vous invite alors à le faire.
Suppression d’un ensemble de commandes
1 Choisissez Final Cut Pro > Commandes > Personnaliser (ou appuyez sur 
Commande +Option + K).
2 Si l’ensemble de commandes à supprimer ne se trouve pas à l’écran, sélectionnez un autre 
ensemble dans le menu local situé dans la partie supérieure de l’éditeur de commandes.
3 Choisissez Supprimer dans le menu local situé dans le coin supérieur gauche de l’éditeur 
de commandes.
4 Dans la fenêtre qui s’affiche, cliquez sur Supprimer.
L’ensemble de commandes est alors supprimé.
Exportation et importation d’ensembles de raccourcis dans l’éditeur de 
commandes
Une fois enregistré un ensemble de commandes, vous pouvez l’exporter pour disposer d’une 
copie de sauvegarde ou pour le partager avec un autre utilisateur. Les ensembles de commandes 
s’enregistrent dans un fichier qu’il est possible d’importer ultérieurement dans Final Cut Pro.
Exportation d’un ensemble de raccourcis clavier personnalisés
1 Choisissez Final Cut Pro > Commandes > Personnaliser (ou appuyez sur 
Commande +Option + K).
2 Si l’ensemble de commandes à exporter ne se trouve pas à l’écran, sélectionnez un autre 
ensemble dans le menu local situé dans la partie supérieure de l’éditeur de commandes.
3 Procédez de l’une des manières suivantes:
• Choisissez Final Cut Pro > Commandes > Exporter.
• Choisissez Exporter dans le menu local situé dans le coin supérieur gauche de l’éditeur 
de commandes.
4 Dans le champ Enregistrer sous, attribuez un nom à l’ensemble de commandes exporté, accédez 
à l’endroit où vous souhaitez conserver l’ensemble exporté, puis cliquez sur Enregistrer.
Le fichier s’enregistre à l’emplacement choisi avec l’extension « .commandset ».
Importation d’un ensemble de commandes
1 Procédez de l’une des manières suivantes:
• Choisissez Final Cut Pro > Commandes > Importer.
• Ouvrez l’éditeur de commandes en choisissant Final Cut Pro > Commandes > Personnaliser, 
puis choisissez Importer dans le menu local situé dans le coin supérieur gauche de l’éditeur 
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2 Dans la fenêtre qui apparaît, accédez à l’emplacement où vous avez stocké le fichier d’un 
ensemble de commandes, sélectionnez-le, puis cliquez sur Ouvrir.
Si vous utilisez déjà un ensemble de commandes portant le même nom, une fenêtre vous invite 
alors à le renommer.
Le nouvel ensemble est alors ajouté au sous-menu Commandes du menu de Final Cut Pro et au 
menu local prévu dans l’éditeur de commandes.480
4:3 Proportions utilisées pour la transmission vidéo analogique en définition standard (SD). Le 
rapport de la largeur sur la hauteur de la zone visible de l’image vidéo est de 4:3, ou 1.33. Voir 
aussi définition standard (SD).
16:9 Proportions écran large utilisée en vidéo. Le rapport de la largeur sur la hauteur de la zone 
visible de l’image vidéo est de 16:9, ou 1.78. Les proportions 16:9 sont utilisées pour la vidéo 
haute définition. Voir aussi haute définition (HD).
AAC (Advanced Audio Coding) Également appelé MPEG-4 Audio. Méthode standard de compression et d’encodage audio numérique. La qualité des fichiers AAC soutient la comparaison 
avec celle des CD audio et est généralement supérieure à celle des fichiers MP3 encodés au 
même débit, voire à des débits supérieurs.
AC3 (Audio Codec 3, Advanced Codec 3, Acoustic Coder 3) Format audio compressé Dolby 
Digital généralement utilisé pour l’encodage du son Surround.
AIFF (Audio Interchange File Format) Format de fichier audio multiplateforme mis au point par 
Apple. Comme les fichiers WAV, les fichiers AIFF incluent des « blocs » d’informations, tels que le 
bloc de données audio (Sound Data Chunk), qui contient les données d’échantillons proprement 
dites, et le bloc commun (Common Chunk), qui comporte les informations relatives à la fré-
quence d’échantillonnage et à la profondeur de bits.
canal alpha Canal d’image, en plus des canaux de couleur R, V et B, utilisé pour stocker des 
données de transparence pour le compositing. Les canaux alpha sont souvent de 8 bits, mais 
certaines applications gèrent les canaux alpha de 16 bits. Dans Final Cut Pro, le noir correspond 
à 100 pour cent de transparence, tandis que le blanc représente 100 pour cent d’opacité. Seuls 
certains formats, tels que Targa, TIFF, PNG, PSD, Apple ProRes 4444 et le codec d’animation 
QuickTime, prennent en charge les canaux alpha. Voir aussi compositing, RVB.
Éditeur d’angles Vous pouvez y ouvrir des plans multicam pour adapter la synchronisation et 
l’ordre des angles ou pour en ajouter ou en supprimer. Vous pouvez aussi passer par l’éditeur 
d’angles pour réaliser des montages dans les différents plans insérés dans un plan multicam (par 
exemple, lors de trim, d’étalonnages, d’ajout de transitions, etc.). Voir aussi plan multicam.
Visualiseur d’angle Visualiseur permettant de visionner simultanément tous les angles d’un plan 
multicam tout en activant ou en coupant vers un autre angle en temps réel. Vous pouvez couper 
et changer les éléments audio et vidéo simultanément ou indépendamment. Par exemple, vous 
pouvez utiliser l’élément audio de l’angle 1 tout en alternant entre les angles 1 à 4 de la vidéo. 
Voir aussi plan multicam.
éditeurs d’animation Consultez Éditeur d’animation audio, Éditeur d’animation vidéo.
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Apple ProRes Les codecs Apple ProRes combinent de manière inégalée performances de multidiffusion et de montage en temps réel et qualité d’image impressionnante, le tout dans des 
fichiers de taille réduite. Plus particulièrement, les codecs Apple ProRes ont été conçus pour 
fonctionner de manière optimale comme codecs haute qualité, hautes performances destinés au 
montage dans Final Cut Pro, en exploitant totalement le traitement multicœur et en procurant 
des modes de décodage rapide en résolution réduite. Tous les codecs de la famille Apple ProRes 
prennent en charge toutes les dimensions d’image (SD, HD, 2K et 4K) en résolution complète. Le 
débit de données Apple ProRes varie selon le type de codec, le contenu d’image, la taille d’image 
et la fréquence d’images.
Apple ProRes 4444 Ce codec Apple ProRes procure la meilleure qualité pour les sources 4:4:4:4 
et convient aux flux de production impliquant des canaux alpha. Il offre des couleurs RVBA 
4:4:4:4 en pleine résolution de qualité Master, visuellement indiscernables du matériel original, 
avec d’excellentes performances de duplication. Il comprend également un canal alpha mathé-
matiquement sans perte (jusqu’à 16 bits) avec lecture en temps réel, une solution haute qualité 
de stockage et d’échange de composites et de graphiques animés, ainsi que l’encodage et le 
décodage direct dans les formats de pixels RVB et Y'CbCr. Ce codec présente un débit de données remarquablement faible par comparaison avec le format HD 4:4:4 sans compression (débit 
de données cible d’environ 330 Mbps pour les sources 4:4:4 à 1920 x 1080 et 29.97 ips). Voir aussi 
Apple ProRes.
Apple ProRes 422 (HQ) Ce codec Apple ProRes procure le même niveau élevé de qualité visuelle 
que le codec Apple ProRes 4444, mais pour des sources d’image 4:2:2. Largement adopté dans 
l’industrie de la postproduction vidéo, le codec Apple ProRes 422 (HQ) permet de préserver sans 
perte la vidéo HD professionnelle de la plus haute qualité qu’un signal HD-SDI (liaison simple) 
peut transporter. Il prend en charge les sources vidéo 4:2:2 en pleine largeur à des profondeurs 
de pixels de 10 bits, sans aucune perte visuelle après de nombreuses opérations de décodage 
et de réencodage. Le débit de données cible du codec Apple ProRes 422 (HQ) est d’environ 
220 Mbps à 1920 x 1080 et 29,97 ips. Voir aussi Apple ProRes.
Apple ProRes 422 Ce codec Apple ProRes procure pratiquement tous les avantages du codec 
Apple ProRes 422 (HQ), mais à 66 % du débit de données de ce dernier et avec des performances 
de multidiffusion et de montage en temps réel supérieures. Voir aussi Apple ProRes.
Apple ProRes 422 (LT) Avec un débit de données cible équivalent à approximativement 70 % 
de celui du codec Apple ProRes 422 et des dimensions de fichier inférieures de 30 %, ce codec 
convient parfaitement aux environnements où la capacité de stockage et la bande passante sont 
limitées. Voir aussi Apple ProRes.
Apple ProRes 422 (Proxy) Ce codec Apple ProRes est destiné aux flux de production offline 
nécessitant de faibles débits de données, mais une vidéo en pleine résolution. Son débit de 
données cible correspond à environ 30 pour cent de celui du codec Apple ProRes 422. Voir aussi 
Apple ProRes.
proportions Rapport de la largeur sur la hauteur d’une image vidéo à l’écran. La vidéo en définition standard (SD) (utilisée par les téléviseurs classiques) présente des proportions de 4:3. La 
vidéo haute définition (HD) présente des proportions de 16:9.
Éditeur d’animation audio Vous pouvez afficher l’éditeur d’animation audio pour des plans dans 
la timeline afin d’ajuster les paramètres des effets, de créer des fondus entrants ou sortants, ou 
de changer les effets dans le temps à l’aide d’images clés.Glossaire 482
composants audio Les fichiers audio peuvent contenir un seul ou plusieurs canaux audio. 
Final Cut Pro regroupe automatiquement les canaux audio en composants audio en fonction de la configuration des canaux pour le plan. Dans Final Cut Pro, vous pouvez développer 
la partie audio de plans pour afficher et monter des composants audio jusqu’au niveau des 
différents canaux.
fréquence d’échantillonnage Nombre de fois qu’un signal audio est mesuré, ou échantillonné, 
par seconde. Plus la fréquence d’échantillonnage est supérieure, plus l’audio est de qualité 
élevée et plus les fichiers produits sont volumineux.
Audio Units Format de filtre audio en temps réel standard des applications audio utilisées 
sous OS X.
formes d’onde audio Les formes d’onde audio sont des représentations visuelles des sons. Leur 
amplitude et leur longueur varient selon le volume et la durée du son qu’elles représentent. Un 
son court et marqué, tel qu’un son de percussion, est représenté par une forme d’onde en pic, 
alors qu’un bruit de foule étouffé présente une forme d’onde plus basse et prolongée. Ces propriétés permettent de trouver plus facilement des points de montage spécifiques au moment 
d’appliquer un trim à des plans ou d’ajouter des images clés à des effets.
audition Dans Final Cut Pro, vous pouvez regrouper des plans connexes dans des ensembles, 
appelés auditions, vous permettant de choisir celui à utiliser. Vous pouvez créer une audition 
composée de différents plans pour tester plusieurs prises ou constituée de plusieurs versions du 
même plan pour effectuer le preview d’effets divers. Dans le navigateur d’événements et la timeline, les auditions se présentent sous la forme de plans affichant une icône Audition dans le coin 
supérieur gauche.
synchronisation audio automatique L’option « Utiliser l’audio pour la synchronisation » dans le 
processus de création des plans multicam permet d’effectuer des réglages de synchronisation 
fins ´l’aide des formes d’onde audio qui s’affichent dans les angles d’un plan multicam. Cette 
technologie est identique à celle de synchronisation audio utilisable pour analyser et synchroniser automatiquement les plans ensemble en un plan composé.
AVCHD Format vidéo haute définition (HD) utilisant la compression AVC (Advanced Video 
Coding) (également appelée MPEG-4 Partie 10 ou H.264). La plupart des lecteurs Blu-ray peuvent 
lire des disques à laser rouge avec du contenu au format AVCHD, ce qui permet de distribuer de 
petits projets vidéo HD à l’aide d’un disque à laser rouge standard.
fenêtre Tâches d’arrière-plan La fenêtre Tâches d’arrière-plan affiche la progression des tâches 
d’importation, de transcodage, d’analyse, de rendu et autres.
lot Compressor place dans un lot le ou les fichiers multimédias source que vous voulez convertir, ou transcoder, vers un autre format. Chaque fichier de média source crée sa propre tâche. En 
d’autres termes, un lot peut contenir plusieurs tâches, chacune d’entre elles s’appuyant sur son 
propre fichier de média source. En outre, chacune possède au moins un réglage qui définit le 
format du fichier transcodé.
débit binaire Nombre de bits par seconde constituant une ressource audio ou vidéo numérique. 
Plus le débit binaire est élevé, plus la qualité est haute. Toutefois, un débit binaire élevé implique 
une taille de fichier importante.
outil Lame de rasoir Outil de montage permettant de couper des plans dans la timeline. Pour 
activer l’outil Lame de rasoir, appuyez sur la touche B.Glossaire 483
support à laser bleu Les graveurs et les lecteurs Blu-ray utilisent un laser bleu pour les supports 
Blu-ray. La couleur bleue possède une longueur d’onde plus courte, ce qui rend possible un stockage plus important de données sur un disque, comparé aux supports laser rouge.
filtrage bleu ou vert Voir incrustation chromatique.
adapté à la diffusion Les studios de télédiffusion fixent des valeurs maximales de luminance 
et de chrominance autorisées pour la diffusion. Si une vidéo dépasse ces limites autorisées, une 
déformation apparaît et la qualité de la transmission obtenue est inacceptable. Vous pouvez utiliser les instruments vidéo de Final Cut Pro pour vous assurer que les niveaux de luminance et de 
chrominance définis restent dans les limites acceptables.
Roll B Terme utilisé pour décrire une séquence alternative à insérer dans les principaux plans 
utilisés dans un programme. Un Roll B est fréquemment utilisé pour des plans de coupe.
BWF (Broadcast Wave Format) Extension du format de fichier WAV qui intègre des métadonnées supplémentaires telles que le timecode et des informations de production.
CAF (Core Audio Format) Le format CAF d’Apple est un format de fichiers souple, destiné au 
stockage et à la manipulation de données audionumériques. Il est totalement pris en charge par 
les API Core Audio sous Mac OS X 10.4 ou ultérieur et sous Mac OS X 10.3 avec QuickTime 7 ou 
ultérieur. Le format CAF, à la fois souple et hautement performant, peut en outre s’adapter aux 
technologies d’enregistrement, de montage et de lecture ultra haute résolution du futur.
chrominance Données sur les couleurs contenues dans un signal vidéo, comprenant la 
teinte, qui représente la couleur proprement dite, et la saturation, qui représente l’intensité de 
la couleur.
incrustation chromatique Technique d’effets spéciaux permettant de dériver un canal alpha ou 
un cache à partir de l’arrière-plan bleu ou vert d’un plan vidéo, afin de le rendre transparent en 
vue d’effectuer un compositing avec d’autres plans. La technologie de filtrage bleu est employée 
pour montrer les présentateurs météo devant une animation satellite, alors qu’ils se trouvent en 
réalité devant un mur bleu. Également connue sous le nom de fond bleu ou de fond vert. Voir 
aussi canal alpha.
plan Terme utilisé pour désigner une ressource vidéo ou audio, en particulier après son importation dans Final Cut Pro. Les plans apparaissent dans le navigateur d’événements, la timeline et 
les navigateurs multimédias. Les plans ou clips dans Final Cut Pro pointent vers des fichiers de 
média source stockés sur disque. Si vous modifiez un plan ou un clip, vous ne modifiez en fait 
pas le fichier de média en tant que tel mais simplement les informations liées au plan ou clip 
dans Final Cut Pro. On parle alors de montage offline.
écrêtage Distorsion qui se produit lors de la lecture ou de l’enregistrement d’audio numérique, 
en raison d’un signal qui dépasse la valeur d’échantillonnage maximale de 0 dBFS.
sélection de plans Sélection de plans complets dans le navigateur d’événements ou la timeline. 
Par rapport à une sélection de plage, une sélection de plans est limitée aux limites des plans. Il 
est impossible d’ajuster une sélection de plans de façon à inclure des sections de plans. Vous 
pouvez cependant ajouter ou supprimer des plans entiers.
codec Abréviation de compresseur/décompresseur ou encodeur/décodeur. Composant logiciel 
utilisé pour convertir de l’audio ou de la vidéo dans une forme numérique compressée sous 
laquelle il est stocké sur le disque dur d’un ordinateur. DV, Photo JPEG et Apple ProRes repré-
sentent des codecs vidéo QuickTime répandus.Glossaire 484
balance des couleurs Désigne le mélange de rouge, vert et bleu dans un plan. Dans 
Final Cut Pro, vous pouvez ajuster la balance des couleurs des zones de tons clairs, intermédiaires 
ou foncés de votre plan en utilisant le réglage colorimétrique.
mires Signal de test de couleur standard affiché sous la forme de colonnes, souvent accompagné d’une tonalité de référence. La mire permet d’ajuster le signal vidéo de la source entrante, 
afin de conserver des couleurs correctes de l’importation jusqu’à la sortie.
réglage colorimétrique Le réglage colorimétrique vous permet d’ajuster manuellement les propriétés des couleurs d’un plan. Il renferme des fenêtres distinctes pour l’ajout ou la soustraction 
d’une teinte de couleur, le contrôle de l’intensité de la couleur et le contrôle de la luminosité de 
la vidéo. En plus d’une commande générale, chaque fenêtre dispose de différentes commandes 
pour la surbrillance, les tons intermédiaires et les zones d’ombrage de l’image.
dominante de couleur Teinte indésirable de l’image, généralement provoquée par des problèmes d’éclairage.
étalonnage Processus au cours duquel la couleur des plans utilisés dans un programme monté 
est harmonisée, afin que tous les plans d’une scène donnée coïncident. L’étalonnage est géné-
ralement l’une des dernières étapes de finalisation d’un programme monté. Les outils d’étalonnage disponibles dans Final Cut Pro vous permettent de contrôler avec précision l’apparence de 
chaque plan de votre projet grâce au réglage de la balance des couleurs, des niveaux de noir, des 
tons intermédiaires et des niveaux de blanc.
différence de couleur Dans les formats vidéo utilisant l’espace colorimétrique Y’CbCr pour le 
stockage des informations sur les couleurs, les canaux de couleur sont dérivés en soustrayant les 
signaux Y (luminance) des signaux R (rouge) et B (bleu) et sont parfois appelés B-Y et R-Y. Voir 
aussi Y’CbCr.
compositing Processus au cours duquel au moins deux images sont combinées en une seule. Ce 
terme peut également s’appliquer au processus de création de divers effets vidéo.
plan composé Vous pouvez utiliser des plans composés pour regrouper des plans de n’importe 
quels types dans la timeline ou le navigateur d’événements et imbriquer des plans dans d’autres 
plans. Vous avez la possibilité d’ouvrir n’importe quel plan composé, en modifier le contenu dans 
la timeline, puis le refermer. Un plan composé peut contenir des composants de plan vidéo et 
clip audio, des plans et d’autres plans composés. Il peut en fait être vu comme un mini-projet 
en soi, avec ses propres réglages de projet. Les plans composés fonctionnent comme les autres 
plans: vous pouvez les ajouter à votre projet, leur appliquer un trim, les resynchroniser et leur 
ajouter des effets et des transitions.
compression Processus réduisant la taille des fichiers vidéo, graphiques et audio. La compression 
« avec perte » désigne le processus qui réduit la taille des fichiers vidéo lorsque vous supprimez 
les données graphiques redondantes ou moins importantes. La compression sans perte réduit la 
taille des fichiers en consolidant mathématiquement les données graphiques redondantes sans 
les supprimer.
plan connecté Les plans connectés sont associés à des plans du scénario principal dans la 
timeline. Les plans connectés s’avèrent utiles pour les plans de coupe, les images superposées 
ou composites et les effets sonores. Les plans connectés restent reliés et synchronisés jusqu’à ce 
que vous les déplaciez ou les supprimiez manuellement. Une suite de plans connectés compose 
un scénario.Glossaire 485
contraste Différence entre les valeurs les plus claires et les plus sombres d’une image. Les 
images qui présentent un grand contraste possèdent un large intervalle de valeurs de l’ombre la 
plus sombre au ton le plus clair. Les images à faible contraste possèdent une gamme étroite de 
valeur. L’aspect obtenu est plus « plat ».
fondu enchaîné Type courant de transition vidéo dans laquelle le premier plan disparaît 
progressivement pendant que le second apparaît, lui aussi, progressivement. Lors du fondu 
enchaîné, les deux plans sont superposés pendant leur fondu respectif.
fondu enchaîné Type courant de transition audio dans laquelle l’audio du premier plan s’affaiblit progressivement pendant que l’audio du second monte, lui aussi, progressivement. Lors du 
fondu enchaîné, l’audio des deux plans est entendu.
coupe Montage dans lequel un plan en suit immédiatement un autre, sans effet de transition. Il 
s’agit du type de montage le plus simple.
plan de coupe Plan ayant un rapport avec le sujet actuel et se produisant dans le même laps 
de temps (par exemple, la réaction d’un interviewer à ce qui se dit dans une interview). Un 
plan de coupe est souvent utilisé pour éliminer une section visuelle non souhaitée d’un autre 
plan. L’audio reste généralement continu lors de la coupe, ce qui vous permet de la rendre 
moins perceptible.
panneau de contrôle Le panneau de contrôle apparaît au centre de la barre d’outils et affiche le 
timecode, ainsi que des icônes indiquant les niveaux audio et l’état des tâches d’arrière-plan.
débit des données Vitesse à laquelle les données peuvent être transférées, souvent exprimée en 
mégaoctets par seconde (Mo/s) ou en mégabits par seconde (Mbps). Plus le débit de données 
d’un fichier vidéo est élevé, plus sa qualité est optimale, mais plus les ressources système (vitesse 
du processeur, espace libre sur le disque dur et performances) sont sollicitées. Certains codecs 
vous permettent de spécifier un débit maximal par film au cours de la capture.
décibel (dB) Unité de mesure des niveaux sonores; échelle logarithmique utilisée pour décrire 
l’intensité d’un son perçu par l’oreille humaine. (1 dB correspond approximativement à la variation de volume la plus faible que l’oreille humaine puisse percevoir.) Pour l’audio numérique, 
dBFS est l’unité de décibel standard pour la mesure du niveau sonore.
destination Ensemble de réglages d’exportation préconfigurés que vous pouvez utiliser pour 
partager un projet ou un plan depuis Final Cut Pro. Les destinations simplifient l’exportation de 
votre film en vue de le visionner sur des dispositifs Apple tels que l’iPhone et l’iPad, le publier sur 
des sites web comme Facebook et YouTube, ou encore le graver sur disque. Final Cut Pro offre 
une panoplie complète de destinations que vous pouvez en outre modifier à loisir ou en créer 
d’autres. Pour ajouter et modifier des destinations, utilisez la fenêtre Destinations des préférences 
de Final Cut Pro.
Utilitaire de disque Utilitaire de disque est une application Apple permettant d’exécuter des 
tâches de gestion de disque dans OS X. Il se trouve dans le dossier /Applications/Utilitaires.
sous-mixage Processus utilisé pour combiner plusieurs canaux audio en une seule paire stéréo 
(ou mono dual). Également appelé mixdown.Glossaire 486
timecode Drop Frame Timecode NTSC qui ignore deux numéros d’image par minute, sauf pour 
les minutes qui se terminent par 0, afin que le timecode corresponde au temps véritablement 
écoulé (les numéros de timecode sont passés mais pas les images vidéo proprement dites). Ce 
saut est effectué pour tenir compte de la fréquence d’images vidéo réelle de la norme NTSC de 
29,97 ips qui décale le timecode Non-Drop Frame de 3 secondes et 18 images par heure par rapport au temps réellement écoulé. Pour éviter toute confusion, il faut éviter d’utiliser un timecode 
Drop Frame dans les productions cinématographiques. Voir aussi timecode Non-Drop Frame.
ombre portée Effet qui crée une ombre artificielle derrière une image. Utilisé surtout avec des 
graphiques et du texte.
DV Format d’enregistrement numérique sur bande vidéo en définition standard (SD) qui enregistre un signal vidéo en composantes 8 bits avec une compression 5:1 et un échantillonnage 
des couleurs 4:1:1 (PAL utilise un échantillonnage 4:2:0). Ce format gère deux pistes audio avec 
un échantillonnage 16 bits et 48 kHz ou quatre pistes audio avec un échantillonnage de 12 bits 
et 32 kHz.
DVCAM Format d’enregistrement numérique sur bande vidéo en définition standard (SD) qui 
enregistre un signal vidéo en composantes 8 bits avec une compression 5:1 et un échantillonnage des couleurs 4:1:1 (PAL utilise un échantillonnage 4:2:0). Ce format gère deux pistes audio 
avec un échantillonnage 16 bits et 48 kHz ou quatre pistes audio avec un échantillonnage de 12 
bits et 32 kHz.
DVCPRO Format d’enregistrement numérique sur bande vidéo en définition standard (SD) qui 
enregistre un signal vidéo en composantes 8 bits avec une compression 5:1 et un échantillonnage des couleurs 4:1:1 (PAL utilise un échantillonnage 4:2:0). Ce format gère deux pistes audio 
avec un échantillonnage audio de 16 bits et 48 kHz.
DVCPRO 50 Format d’enregistrement numérique sur bande vidéo en définition standard (SD) 
qui enregistre un signal vidéo en composantes 8 bits avec une compression 3.3:1 et un échantillonnage des couleurs 4:2:2. Ce format gère quatre pistes audio avec un échantillonnage audio de 
16 bits et 48 kHz.
DVCPRO HD Format vidéo haute définition (HD) qui enregistre un signal vidéo en composantes 
8 bits compressé avec un échantillonnage des couleurs 4:2:2. 720p et 1080i sont pris en charge. 
Inclut jusqu’à huit pistes audio avec un échantillonnage 16 bits et 48 kHz. Le débit de données 
total est de 115 Mbps.
DVD Disque de la taille d’un CD, mais utilisant des méthodes de stockage haute densité qui 
augmentent considérablement sa capacité. Généralement utilisés pour la distribution vidéo, les 
disques DVD-ROM peuvent également être utilisés pour stocker des données informatiques.
plage dynamique Différence, exprimée en décibels, entre la partie d’un enregistrement dont le 
volume est le plus élevé et celle dont le volume est le plus bas.
outils d’édition Sept outils parmi lesquels choisir lors de vos manipulations dans la timeline : 
outil de sélection, outil Trim, outil Position, outil Sélection de plage, outil Lame de rasoir, outil 
Zoom et outil Main. Après avoir choisi un outil, l’icône du pointeur s’adapte pour refléter l’usage 
de l’outil en question.Glossaire 487
point de montage Les points de montage définissent la partie d’un plan que vous souhaitez 
utiliser dans le projet monté. Les points de montage comprennent les points de départ, qui définissent le début d’une section d’un plan ou d’un projet, et les points d’arrivée, qui définissent la 
fin d’une section d’un plan ou d’un projet. Un point de montage est également un point dans la 
timeline où le point d’arrivée d’un plan coïncide avec le point de départ du plan suivant. Il peut 
être sélectionné pour diverses opérations.
Navigateur d’effets Navigateur multimédia de Final Cut Pro contenant des effets de plan vidéo 
et de clip audio.
égalisation Un égaliseur (généralement appelé EQ, pour « equalizer ») modèle le son de l’audio 
entrant en modifiant le niveau de bandes de fréquences spécifiques. L’égalisation constitue l’un 
des traitements audio les plus couramment utilisés, aussi bien pour les projets de musique que 
dans les travaux de postproduction vidéo. Vous pouvez passer par l’égalisation pour former subtilement ou plus nettement le son d’un fichier audio, d’un instrument ou d’un projet en ajustant 
des fréquences précises ou des plages entières.
événement Lorsque vous importez du contenu vidéo, audio ou des images fixes ou que vous les 
enregistrez directement dans Final Cut Pro, les fichiers multimédias source (votre métrage brut) 
sont stockés dans des événements. Un événement correspond à un dossier qui peut contenir des 
dizaines, des centaines, voire des milliers de plans vidéo, de clips audio et d’images fixes. Chaque 
événement de la bibliothèque d’événements correspond à un dossier de votre disque dur qui 
contient les fichiers de média originaux, tout fichier de rendu relatif à votre média et un fichier 
de base de données comprenant le suivi de l’emplacement de l’ensemble des éléments.
Navigateur d’événements Le navigateur d’événements affiche les plans correspondant à l’élé-
ment sélectionné dans la bibliothèque d’événements. Il vous suffit de sélectionner des plans ou 
des sections de plan dans le navigateur d’événements pour commencer à travailler dessus. Vous 
pouvez trier les plans dans le navigateur d’événements par date de création, par date d’importation, par bande, par scène, par durée de plan ou par type de fichier. Vous pouvez aussi visualiser 
vos plans sous forme de pellicule ou de liste.
Bibliothèque d’événements La bibliothèque d’événements référence et organise les événements contenant les données que vous avez importées (vidéo, audio et images fixes). Lorsque 
vous sélectionnez un événement dans la bibliothèque d’événements, le média qu’il contient 
s’affiche sous forme de plans dans le navigateur d’événements. La bibliothèque d’événements 
contient également les collections de mots-clés et les collections intelligentes de Final Cut Pro 
qui vous permettent d’organiser efficacement votre média à l’aide de mots-clés et de filtres de 
recherche persistants.
visualiseur d’événements Le visualiseur d’événements représente un affichage vidéo à 
part à côté du visualiseur principal, servant uniquement à lire des plans dans le navigateur 
d’événements.
exposition Quantité de lumière dans des images vidéo ou des images de film. L’exposition 
modifie la luminosité générale de l’image, ainsi que son contraste.
fondu Type de transition couramment utilisé pour la vidéo et l’audio. Dans le cas de la vidéo, 
un fondu sortant commence par un plan dont l’intensité, maximale au début, réduit progressivement jusqu’à disparaître. À l’inverse, un fondu entrant commence par un plan dont l’intensité, 
nulle au départ, augmente progressivement jusqu’à son niveau maximal. On appelle souvent ces 
transitions « fondu au noir » et « fondu à l’ouverture ». Les fondus audio commencent pour leur 
part avec un volume nul qui augmente pour atteindre le volume complet, alors que le fondu sortant commence au volume complet pour se réduire jusqu’au silence.Glossaire 488
pellicule Vos plans vidéo apparaissent sous forme de pellicules dans la timeline (là où vous créez 
vos projets) et dans le navigateur d’événements (là où sont affichées vos données source). Une 
seule pellicule vidéo peut représenter plusieurs secondes de vidéo regroupant des centaines 
d’images vidéo (à savoir des images spécifiques). Les clips exclusivement audio se présentent 
comme des formes d’onde audio, affichant les changements de volume dans le temps.
FireWire Marque déposée d’Apple pour la norme IEEE 1394. FireWire constitue une interface 
rapide et polyvalente permettant de relier des caméscopes DV à des ordinateurs. FireWire 
convient parfaitement aux applications déplaçant de grands volumes de données et peut servir 
à connecter des disques durs, des scanners et d’autres types de périphériques.
effets de bruitage Les effets de bruitage sont des effets sonores personnalisés parfaitement synchronisés avec l’image, tels que des bruits de pas sur différentes surfaces, le froissement de vêtements, des sons de combat et le bruit d’objets manipulés. Final Cut Pro inclut un certain nombre 
de bruitages et d’autres effets sonores que vous pouvez utiliser comme clips audio connectés.
image Image fixe isolée. Les films et les vidéos sont composés d’une série de ces images. Même 
si une image d’un film correspond à une seule image photographique, une image vidéo entrelacée contient deux trames. Voir aussi vidéo entrelacée, vidéo non entrelacée.
fusion d’images La duplication d’images en vue de créer un ralenti peut produire un effet 
stroboscopique perturbant. Pour limiter cet effet, vous pouvez activer la fusion d’images dans le 
menu local Resynchronisation accessible à partir de la barre d’outils. La fusion d’images crée des 
images intermédiaires, chacune constituant une image composite des deux images contigües de 
chaque côté.
fréquence d’images Nombre d’images photographiées par seconde pour un plan vidéo.
taille d’image Voir résolution.
fréquence Nombre de fois qu’un son ou un signal vibre par seconde. La fréquence est exprimée 
en cycles par seconde, ou hertz (Hz). Les enregistrements audio sont composés d’une large série 
de formes d’onde, qui utilisent de nombreuses fréquences de son différentes. Chaque fréquence 
d’enregistrement est associée à une tonalité audio. Par exemple, la note produite par chaque 
touche d’un piano a sa propre fréquence.
Front Row Front Row, application fournie avec OS X, vous permet de parcourir vos données 
iTunes, iLife et Final Cut Pro à l’aide d’une télécommande Apple Remote ou de l’application 
Remote. Il est également possible d’ouvrir Front Row en appuyant sur Commande + Échap.
gain Niveau de gain d’un signal audio ou vidéo. En vidéo, cette valeur augmente le niveau de 
blanc ; en audio, c’est le volume qui est augmenté. 
gamma Courbe décrivant l’intensité d’une image. Gamma constitue une fonction non linéaire 
souvent confondue avec la « luminosité » ou le « contraste ». La correction gamma est fréquemment utilisée pour atténuer les différences entre les cartes vidéo et les écrans Mac et Windows.
plan vide Plan vierge (contenant de la vidéo vierge et du silence) dont vous pouvez définir librement la durée. (L’industrie audiovisuelle emploie le terme d’amorce pour le désigner.) La couleur 
du plan vide se détermine par celle de l’arrière-plan actif dans Final Cut Pro. Vous pouvez adapter 
la couleur d’arrière-plan à l’aide du menu local « Arrière-plan du lecteur » dans la fenêtre Lecture 
des préférences de Final Cut Pro.
générateurs Plans synthétisés par Final Cut Pro. Ces derniers peuvent constituer différents types 
d’arrière-plans, de titres et d’éléments visuels.Glossaire 489
navigateur de générateurs Navigateur multimédia de Final Cut Pro permettant d’accéder à tous 
les générateurs vidéo inclus dans Final Cut Pro.
outil Main Outil de montage permettant de faire défiler la timeline. Pour activer l’outil Main, 
appuyez sur la touche H.
H.264 H.264/MPEG-4 Part 10 ou AVC (Advanced Video Coding) est un standard de compression 
vidéo largement utilisé pour l’enregistrement, la distribution et la diffusion sur Internet de vidéo 
en haute définition.
HDCAM Format d’enregistrement numérique sur bande vidéo en haute définition (HD) qui enregistre un signal vidéo en composantes 8 bits avec une compression 7.1:1 DCT et un échantillonnage des couleurs 3:1:1. Enregistré sur une bande d’1/2 pouce. Il gère quatre pistes audio.
HDV Ce format est destiné à enregistrer de la vidéo haute définition sur bande DV. Le format 
HDV fait appel à la compression vidéo MPEG-2 avec des échantillons 8 bits et un sous-échantillonnage de chrominance 4:2:0. Il possède un débit vidéo de 18,3 Mbps à 720p (1280 x 720) et de 
25 Mbps à 1080i (1440 x 1080).
haute définition (HD) Désigne toute vidéo dont la résolution est supérieure à celle de la vidéo 
NTSC ou PAL en définition standard. Les résolutions haute définition les plus courantes sont 1280 
x 720 (720p) et 1920 x 1080 (1080i ou 1080p). Voir aussi format NTSC, format PAL, définition standard (SD).
histogramme Instrument vidéo de Final Cut Pro offrant une analyse statistique de l’image en 
représentant graphiquement le nombre de pixels à chaque pourcentage de luminance ou de 
couleur. Il est utile pour comparer deux plans afin de mieux faire correspondre leurs valeurs 
de luminosité.
teinte Attribut de perception de la couleur, également appelé phase de couleur. Le rouge, le 
bleu, le jaune et le vert sont tous des teintes.
importation Processus consistant à placer des fichiers multimédias de différents types dans 
des événements dans Final Cut Pro. Vous pouvez importer des fichiers depuis des caméscopes 
et d’autres appareils connectés, depuis d’autres applications ou depuis des périphériques de 
stockage connectés.
IMX Format MPEG-2 en définition standard (SD) d’imagesI stockées sur bande, disque optique 
XDCAM ou disque dur. Certaines platines IMX peuvent lire et convertir les formats tels que Digital 
Betacam, Betacam SX et Betacam SP en IMX. Le débit des données IMX peut être réglé sur 30, 40 
ou 50 Mbps.
plan entrant Plan suivant une transition. Par exemple, si le plan A fait l’objet d’un fondu vers le 
plan B, ce dernier est le plan entrant. Voir aussi plan sortant.
inspecteur d’informations L’inspecteur d’informations affiche des informations (appelées métadonnées) concernant un plan ou un groupe de plans sélectionné dans le navigateur d’événements ou la timeline. Il vous est possible d’afficher plusieurs combinaisons de métadonnées avec 
vos plans, telles que des codecs, les moments de début et de fin du média, la bande, la scène, 
la prise, les renseignements EXIF et les informations IPTC. Vous pouvez aussi passer par l’inspecteur d’informations pour modifier les métadonnées pour un plan ou groupe de plans choisi, et 
pouvez créer des ensembles personnalisés de métadonnées affichables par le biais de la fenêtre 
Présentations des métadonnées accessible depuis l’inspecteur d’informations.
point d’entrée Voir point de montage.Glossaire 490
montage par insertion Un montage par insertion place le plan source de façon à ce que tous 
les plans situés après le point d’insertion soient déplacés vers l’avant (Ripple) dans la timeline 
pour faire de la place au plan inséré. Aucun plan n’est supprimé de votre projet. Un montage par 
insertion allonge le projet de la durée du plan inséré.
inspecteurs Final Cut Pro comporte un certain nombre d’inspecteurs permettant de consulter 
et de modifier les attributs des éléments sélectionnés. Par exemple, il est possible de régler des 
effets vidéo et d’appliquer des étalonnages dans l’inspecteur vidéo. Les autres inspecteurs sont 
les inspecteurs audio, d’améliorations audio, d’informations, de transition, des titres, de texte, du 
générateur et de partage. Ils apparaissent dans la fenêtre Inspecteur située dans le coin supérieur 
droit de la fenêtre principale de Final Cut Pro.
vidéo entrelacée Méthode de balayage qui divise une image vidéo en deux trames, chacune 
d’elles étant constituée de lignes paires et impaires alternées, balayées à différents moments.
IRE Unité de mesure d’un signal vidéo analogique pour la luminance, définie par l’Institute of 
Radio Engineers.
coupe en J Voir montage scindé.
tâche Chaque fichier multimédia ajouté à un lot dans Compressor constitue une tâche. Chaque 
tâche possède un fichier de média et un ou plusieurs réglages définissant le type de fichier à 
rendre. Voir aussi lot.
JPEG Format de fichier d’image très répandu permettant de créer des fichiers graphiques très 
compressés. Le taux de compression peut varier. Plus la compression est faible, plus la qualité de 
l’image est bonne.
image clé Commande représentant la valeur d’un paramètre d’effet vidéo ou audio en un 
point donné du projet. Lorsque deux images clés avec des valeurs différentes sont définies dans 
Final Cut Pro, une transition d’une valeur à l’autre est calculée, entraînant un changement dynamique de ce paramètre. Le terme image clé est issu de l’animation traditionnelle, où seules les 
images importantes (clés) d’une séquence animée étaient dessinées pour esquisser l’animation 
d’un personnage au fil du temps. Une fois les images clés déterminées, un artiste d’interpolation 
dessine toutes les images intermédiaires.
incrustation Voir incrustation chromatique, incrustation en luminance.
collection de mots-clés Lorsque vous appliquez un mot-clé à un plan, une collection de motsclés est automatiquement créée dans la bibliothèque d’événements. Lorsque vous sélectionnez 
la collection de mots-clés, chaque plan auquel le mot-clé en question a été affecté est affiché.
mots-clés Les mots-clés ajoutent des informations descriptives à un plan ou une plage de plan. 
Vous pouvez faire appel à des mots-clés pour organiser, trier et classifier le média. Il vous est 
possible d’ajouter manuellement des mots-clés à un plan ; Final Cut Pro peut en outre en ajouter 
automatiquement lors de l’analyse de plans. Voir aussi Collection de mots-clé.
coupe en L Voir montage scindé.
montage linéaire Avant l’apparition du montage vidéo numérique, les programmes étaient 
montés en copiant l’un après l’autre les plans sur une bande Master à partir des bandes source 
originales. L’assemblage étant linéaire, tout changement de durée apporté à un point anté-
rieur de la bande nécessitait le réassemblage du film à partir de ce point. Voir aussi montage 
non linéaire.Glossaire 491
en boucle Mode de lecture selon lequel les plans et les projets retournent au début à chaque 
fois que la tête de lecture atteint la fin des données. Vous pouvez activer ou désactiver la lecture 
en boucle à partir du menu Présentation ou en appuyant sur Commande + L.
tiers inférieur Terme utilisé dans le secteur télévisuel pour désigner un graphisme placé dans la 
zone inférieure de l’écran, généralement pour apporter des précisions sur un sujet ou un produit. 
Un usage courant des tiers inférieurs est d’identifier des individus à l’écran à l’aide de leur nom et 
de leur fonction professionnelle.
luminance Valeur décrivant la luminosité d’une image vidéo. Un canal de luminance est une 
image en niveaux de gris indiquant la gamme de luminosité de l’ensemble du plan.
incrustation en luminance Filtre utilisé pour exclure les pixels présentant une valeur de luminance (ou une plage de valeurs de luminance) donnée, créant ainsi un cache basé sur la zone 
la plus claire ou la plus sombre d’une image. L’exclusion de valeurs de luminance est optimale 
lorsqu’un plan dispose d’un large écart dans son exposition entre les zones de l’image que l’on 
souhaite exclure et les images de premier plan que l’on veut conserver, par exemple un titre 
blanc sur un fond noir. Voir aussi incrustation chromatique, cache.
Mail Mail est l’application de messagerie électronique fournie avec OS X.
marqueurs Les marqueurs permettent d’ajouter des remarques de montage ou d’autres informations descriptives à un emplacement précis d’un plan. Vous pouvez aussi utiliser des marqueurs pour la gestion des tâches. Ils se classifient en marqueurs standard (bleus), en marqueurs 
de chapitre (orange), en tâches à réaliser (rouges) ou en tâches accomplies (vertes).
masque Image ou plan servant à définir des zones de transparence dans un autre plan. 
S’apparente à un canal alpha. Les outils d’étalonnage peuvent créer des masques d’après une 
couleur choisie ou une forme créée. Voir aussi canal alpha.
cache Parfois appelé cache de maintien. Effet qui exploite les données d’une couche vidéo pour 
en modifier une autre. Les caches s’avèrent utiles dès qu’il s’agit d’utiliser un plan pour masquer 
ou révéler de façon sélective une partie d’un autre plan. Vous pouvez par exemple faire appel 
à une forme représentant une lumière pour révéler des parties d’une couche vidéo. Les effets 
de cache peuvent servir à masquer des zones d’un plan ou à créer des données de canal alpha 
pour un plan, afin de tracer une bordure transparente autour du plan à combiner avec d’autres 
couches. Voir aussi canal alpha, compositing.
média Terme générique désignant des éléments tels que des films, des sons et des images.
navigateurs multimédias Les données que vous importez dans des événements dans 
Final Cut Pro sont accessibles via la bibliothèque d’événements et le navigateur d’événements, 
mais Final Cut Pro propose également un ensemble de navigateurs multimédias que vous 
pouvez utiliser pour ajouter des plans à votre projet. Les navigateurs multimédias permettent 
d’accéder aux effets, titres et transitions fournies avec Final Cut Pro ainsi qu’aux fichiers vidéo, 
audio et d’images tirés d’autres applications sur votre ordinateur. Par exemple, le navigateur 
de photos vous permet d’accéder aux fichiers vidéo et d’images des bibliothèques Aperture et 
iPhoto. Final Cut Pro propose également les navigateurs d’effets, de musique et son, de transitions, de titres, de générateurs et de thèmes. Les navigateurs multimédias s’affichent dans la 
fenêtre Navigateur multimédia située dans le coin inférieur droit de la fenêtre principale de 
Final Cut Pro.
poignée de données Données supplémentaires disponibles avant le point de départ ou après le 
point d’arrivée d’un plan.Glossaire 492
stems Fichiers audio ou vidéo habituellement exportés séparément pour le mixage audio ou 
la postproduction, ou encore pour correspondre aux spécifications exigées en cas de remise 
de fichiers à des réseaux de diffusion. C’est le cas, par exemple, lorsque vous devez remettre un 
fichier QuickTime multipiste accompagné de stems séparés pour les dialogues, la musique et 
les effets.
mixage Processus qui consiste à ajuster les niveaux audio de tous les clips audio d’un programme monté, notamment l’audio de production, la musique, les effets sonores, les voix 
off et les bruits de fond ambiants supplémentaires, pour transformer tous ces sons en un 
tout harmonieux.
monochrome Image présentée en nuances d’une même couleur, le plus souvent en nuances de 
gris dans une image noir et blanc.
MP3 Ce terme fait référence au format de fichier et au standard de compression MPEG-1 ou 
MPEG-2 Audio Layer 3. Comme pour le format AAC, le MP3 utilise un codage audio perceptuel 
et un algorithme de compression psycho-acoustique pour éliminer l’information superflue inaudible pour l’oreille humaine.
MPEG (Moving Picture Experts Group) Groupe de normes de compression pour la vidéo et 
l’audio, incluant MPEG-1, MPEG-2 et MPEG-4.
Plan multicam Ensemble de plans regroupés et synchronisés par un point de synchronisation 
commun. Vous pouvez exploiter des plans multicam pour monter le métrage de prises multicaméra ou tout autre métrage synchronisé en temps réel. Alors que les angles actifs se reproduisent dans le visualiseur, vous pouvez également visionner tous les angles simultanément dans 
le visualiseur d’angle, puis effectuer des coupes et passer facilement d’un angle à l’autre.
navigateur de musique et son navigateur multimédia de Final Cut Pro vous permettant 
d’accéder à votre bibliothèque iTunes, ainsi qu’aux effets sonores et aux boucles de Final Cut Pro 
et d’iLife.
séquence imbriquée Voir plan composé.
NLE Abréviation de NonLinear Editor (monteur non linéaire). Voir aussi montage non linéaire.
montage non destructif Quelle que soit la façon dont vous montez vos plans dans Final Cut Pro, 
les données sous-jacentes ne sont jamais modifiées. Cette méthode est connue sous le nom 
de montage non destructif, car l’ensemble des modifications et des effets appliqués à votre 
métrage n’a aucun effet sur les fichiers de média source d’origine. Les plans représentent votre 
média mais ne sont pas des fichiers de média en tant que tels. Les plans dans un projet pointent 
simplement sur des fichiers de média source se trouvant sur votre disque dur. Si vous modifiez 
un plan, vous ne modifiez en fait pas le fichier de média en tant que tel mais simplement les 
informations liées au plan dans le projet. Les parties des plans effacées ou ayant fait l’objet d’un 
trim ne sont supprimées que du projet, et non des plans source présents dans votre bibliothèque 
d’événements ni des fichiers multimédias source stockés sur votre disque dur.
timecode Non-Drop Frame Timecode dans lequel les images sont numérotées de manière 
séquentielle, sans suppression de numéros de timecode du décompte. S’agissant de la vidéo 
NTSC, la fréquence d’images vidéo réelle est de 29,97 ips et le timecode Non-Drop Frame est 
décalé de 3 secondes et 18 images par heure par rapport au temps réellement écoulé. Voir aussi 
timecode Drop Frame.Glossaire 493
vidéo non entrelacée Représentation standard des images sur un ordinateur. Autre nom de 
balayage progressif. Le moniteur affiche l’image en dessinant les lignes une à une, du haut 
vers le bas.
montage non linéaire Méthode de montage vidéo permettant de modifier à tout moment les 
montages au sein d’un programme sans avoir à recréer l’ensemble du programme. Lorsque vous 
utilisez une application de montage non linéaire pour un programme, tout le métrage utilisé est 
stocké sur un disque dur et non sur bande. Vous pouvez ainsi accéder de façon aléatoire à toutes 
les données vidéo, audio et à toutes les images au cours du montage. Voir aussi montage linéaire.
format NTSC Norme vidéo définie par l’organisation NTSC (National Television Standards 
Committee), à l’origine des normes de télédiffusion en vigueur en Amérique du Nord. La vidéo 
NTSC analogique comporte 525 lignes entrelacées par image, une fréquence d’images de 
29,97 ips et une gamme de couleurs limitée. La vidéo numérique NTSC a une dimension d’image 
de 720 x 486 pixels (720 x 480 pour DV et DVD) et une fréquence d’images de 29,97 ips. Voir aussi 
format PAL.
montage hors ligne Traitement de postproduction dans lequel le métrage brut est copié et 
modifié sans affecter les données d’origine de la caméra (données sur film, bande ou par système de fichiers). Après l’usage d’un programme dans un montage offline (généralement par le 
biais de média proxy dans une résolution inférieure), un montage online est réalisé pour recréer 
le montage à l’aide du média d’origine.
opacité Niveau de transparence d’un plan.
plan sortant Plan précédant une transition. Par exemple, si le plan A fait l’objet d’un fondu vers 
le plan B, le plan A est le plan sortant. Voir aussi plan entrant.
point de sortie Voir point de montage.
montage par écrasement Dans un montage par écrasement, un ou plusieurs plans source 
écrasent les plans présents dans le scénario principal ou un scénario sélectionné, en commen-
çant au point de départ d’une sélection de plage ou au niveau du skimmer ou de la tête de 
lecture. Puisqu’aucun élément de plan ne subit de montage Ripple en avant, la durée de votre 
projet reste inchangée. L’écrasement s’appuie exclusivement sur la durée et ne fonctionne que 
sur des plages de sélection, indépendamment des limites des plans.
format PAL Acronyme de Phase Alternating Line, un format de vidéo entrelacée à 25 ips 
(625 lignes par image) utilisé dans de nombreux pays européens. Le format vidéo numérique PAL 
a une dimension d’image de 720 x 576. Voir aussi format NTSC.
navigateur de photos Navigateur multimédia de Final Cut Pro vous permettant d’accéder à vos 
bibliothèques de photos iPhoto et Aperture.
tonalité Les sons sont perçus comme aigus ou graves selon leur fréquence, ou le nombre de fois 
par seconde qu’une onde sonore passe d’une pression positive à une pression négative avant de 
revenir à une pression positive. Les musiciens utilisent généralement le terme de tonalité pour 
parler de fréquence. Plus cette dernière est élevée, plus la tonalité l’est aussi. L’adaptation de la 
vitesse d’un plan influe sur la tonalité de sa piste audio. Une animation plus lente crée une tonalité basse ; à l’inverse, une animation plus rapide entraîne une tonalité plus aigue.
pixel Point dans une vidéo ou une image fixe. Plus une image contient de pixels, plus sa résolution est élevée.Glossaire 494
tête de lecture La tête de lecture indique la position actuelle de votre projet dans la timeline 
ou le navigateur d’événements. Vous pouvez à loisir déplacer la tête de lecture en la faisant glisser ou en cliquant sur une autre zone de la timeline ou du navigateur d’événements. La tête de 
lecture permet d’effectuer un défilement ou de parcourir votre projet et de le reproduire depuis 
divers emplacements. La tête de lecture se présente sous la forme d’un trait vertical gris fixe à 
moins que vous ne la déplaciez ailleurs ou cliquiez sur un autre point. Voir aussi skimmer.
outil Position Outil de montage permettant de positionner des éléments dans la timeline. Pour 
activer l’outil Position, appuyez sur la touche P.
postproduction Phase du montage vidéo ou de film au cours de laquelle tous les éléments de 
production sont organisés, assemblés et utilisés pour générer le fichier de sortie.
projet Un projet contient tous vos choix de montage et les données utilisées. Pour créer votre 
projet, vous ajoutez des plans et vous les montez dans la timeline. Un projet est également défini 
par ses propriétés vidéo, audio et de rendu. Dans la plupart des cas, Final Cut Pro gère automatiquement les réglages du projet en fonction des propriétés du premier plan que vous ajoutez 
au projet.
bibliothèque de projets La bibliothèque de projets contient tous les projets Final Cut Pro pré-
sents sur votre disque dur et sur les lecteurs externes connectés.
propriétés du projet Événement par défaut d’un projet, ainsi que les propriétés vidéo, audio et 
de rendu du projet. Dans la plupart des cas, Final Cut Pro gère automatiquement les propriétés 
du projet en fonction des propriétés du premier plan que vous y ajoutez. Si vous devez modifier 
les propriétés du projet, choisissez celles vidéo et audio selon le mode de partage de votre film 
final avec votre public. Vous définissez en fait les propriétés d’un projet au moment où vous 
créez un projet Final Cut Pro ; vous pouvez les modifier ensuite à tout moment.
fichiers proxy Vous pouvez utiliser Final Cut Pro pour transcoder vos données d’origine afin de 
créer des fichiers proxy, qui sont des fichiers plus légers avec un débit de données inférieur. Les 
fichiers proxy peuvent être utilisés pour le montage hors ligne ou pour réaliser un montage sur 
un ordinateur lent. Final Cut Pro crée les fichiers vidéo proxy à l’aide du codec Apple ProRes 422 
(proxy) et les fichiers image proxy à l’aide du format JPEG (si le fichier original ne possède pas 
d’informations de canal alpha) ou PNG (si le fichier possède des informations de canal alpha). 
Voir aussi canal alpha.
QuickTime Technologie multimédia multiplateforme d’Apple. Très répandue pour la production, 
la postproduction et la distribution de programmes vidéo, audio et interactifs.
plage Au lieu de sélectionner des plans complets, vous pouvez sélectionner une plage au sein 
d’un plan dans la timeline ou le navigateur d’événements. Vous pouvez appliquer des trims 
aux sélections de plage, leur attribuer des classements et des mots-clés et les modifier de toute 
autre manière. Vous pouvez ajuster les points d’entrée et de sortie d’une plage en faisant glisser 
l’un des bords figurant de part et d’autre de celle-ci.Dans la timeline, vous pouvez également 
sélectionner une plage couvrant plusieurs plans. Dans le navigateur d’événements, vous avez la 
possibilité de définir plusieurs plages dans un ou plusieurs plans et vous pouvez sélectionner et 
désélectionner des plages après les avoir établies.
outil Sélection de plage Outil de montage permettant de sélectionner une plage dans la timeline. Pour activer l’outil Sélection de plage, appuyez sur la touche R.Glossaire 495
support à laser rouge Les graveurs et les lecteurs de DVD classiques utilisent un laser rouge 
pour les supports DVD. Les graveurs et les lecteurs Blu-ray utilisent un laser bleu pour fonctionner avec un support Blu-ray. La couleur bleue possède une longueur d’onde plus courte, ce qui 
rend possible un stockage plus important de données sur un disque, comparé aux supports 
laser rouge.
rendu Traiter la vidéo et l’audio avec tous les filtres ou les transitions appliqués, puis stocker le 
résultat sur disque sous forme de fichier de rendu. Ces fichiers de rendu sont stockés avec vos 
fichiers d’événements et de projets Final Cut Pro. Lors de la publication ou de l’exportation d’un 
projet, ceux-ci voient leur rendu effectué de façon analogue pour générer les fichiers en sortie.
montage par remplacement Dans un montage par remplacement, la sélection source remplace 
un plan de votre projet dans la timeline. Contrairement aux montages par écrasement, le remplacement ne fonctionne que sur des plans complets de la timeline et peut modifier la durée 
du projet.
résolution La résolution d’une image fait référence au nombre de pixels qu’elle contient. La 
résolution s’exprime en pixels, pour la largeur et la hauteur de l’image (par exemple, 640 x 360 
pixels). Les images de résolution supérieure s’avèrent plus détaillées mais obligent également à des fichiers plus volumineux nécessitant plus de temps à télécharger. Vos dispositifs 
électroniques (ordinateur, iPhone, iPad, iPod, etc.) sous-entendent aussi une résolution écran. 
Dans l’idéal, vous devez adapter la résolution d’image de votre média à celle de lecture sur 
votre appareil.
réverbération La réverbération désigne le phénomène de persistance du son du fait des 
réflexions des ondes sonores sur les surfaces (murs, plafonds, fenêtres, etc.) ou les objets d’un 
espace, qui s’affaiblissent progressivement jusqu’à devenir inaudibles. Final Cut Pro inclut de 
nombreux effets audio qui ajoutent de la réverbération au son d’un plan.
RVB Abréviation de Rouge, Vert, Bleu. Espace colorimétrique couramment utilisé par les ordinateurs, sur lesquels chaque couleur est définie par la force de ses composantes de rouge, de vert 
et de bleu. Cet espace procède directement à la transcription en luminophores rouges, verts 
et bleus utilisés par les écrans d’ordinateurs. La gamme de l’espace colorimétrique RVB est très 
large, permettant ainsi la reproduction d’une grande variété de couleurs. Cette gamme est habituellement plus large que celle pouvant être reproduite pour la télédiffusion.
montage Ripple Le type de trim par défaut dans Final Cut Pro est le trim Ripple qui ajuste le 
point de départ ou d’arrivée d’un plan sans laisser de vide dans la timeline. La modification de 
la durée du plan est propagée vers l’extérieur, avançant ou reculant tous les plans suivants dans 
la timeline. De même, si vous supprimez un plan de la timeline, les plans suivants s’adaptent en 
amont pour fermer le vide. Les montages Ripple affectent le plan auquel le trim est appliqué, la 
position de tous les plans suivants sur la timeline et la durée totale du projet.
rôle Étiquettes de métadonnées que vous associez à des plans dans le navigateur d’événements 
ou la timeline. Elles procurent un moyen à la fois souple et performant de gérer des flux de production de montage. Les rôles peuvent être utilisés dans Final Cut Pro pour organiser des plans 
dans des événements et des projets, contrôler l’apparence de la timeline ou exporter des fichiers 
vidéo ou audio séparés (également appelés stems) en vue d’un mixage audio, de la postproduction ou d’une remise à des réseaux de diffusion.
montage Roll Montage qui modifie deux plans partageant un point de montage. Par exemple, 
si le plan A fait l’objet d’un cut vers le plan B, un montage Roll ajuste simultanément de la même 
quantité le point d’arrivée du plan A et le point de départ du plan B. La durée globale du projet 
reste la même.Glossaire 496
montage brut Premier montage. Le montage brut est une première version d’un film qui 
regroupe ses éléments de base. La plupart du temps, un montage brut est réalisé avant l’ajout de 
transitions, de filtres et d’autres effets.
saturation Mesure de l’intensité de la couleur du signal vidéo.
scène Série de prises de vue qui ont lieu au même moment et au même endroit. Un programme 
est composé d’une série de scènes.
outil Sélectionner Pointeur par défaut en forme de flèche permettant de sélectionner des élé-
ments dans la timeline. Vous pouvez l’utiliser pour sélectionner un plan ou un point de montage 
par exemple. Pour activer l’outil Sélectionner, appuyez sur la touche A.
séquence Voir projet, timeline.
menu contextuel Menu auquel vous accédez en maintenant enfoncée la touche Contrôle et en 
cliquant sur un élément à l’écran, ou en appuyant sur le bouton droit de la souris. Parfois appelé 
menu de raccourci.
plan Segment de vidéo enregistrée en continu. Un plan (ou « prise ») est la plus petite unité 
d’un programme.
skimmer Le skimmer permet de prévisualiser des plans dans la timeline, le navigateur d’évé-
nements ou la bibliothèque de projets sans modifier la position de la tête de lecture. Utilisez le 
skimmer pour survoler le contenu ou parcourir à loisir les plans pour effectuer la lecture depuis 
l’emplacement du pointeur en fonction de sa vitesse de déplacement. Le skimmer se présente 
sous la forme d’un trait vertical rose au fur et à mesure que vous déplacez le pointeur sur la zone 
en cours de survol. Si vous avez activé le magnétisme, le skimmer devient orange lorsqu’il est 
calé sur une position.
clap Plan au début d’une scène, qui identifie celle-ci à l’aide d’informations de base sur la production, telles que la prise de vue, la date et le numéro de la scène. Un clap fournit un signal 
audiovisuel pour la synchronisation lorsque la vidéo et l’audio sont enregistrés séparément.
montage par glissement Montage dans lequel la totalité d’un plan est déplacée, ainsi que les 
points de montage de part et d’autre de celui-ci. La durée du plan déplacé reste inchangée, mais 
la longueur des plans à sa gauche et à sa droite est modifiée en fonction de la nouvelle position 
du plan. La durée totale du projet et de ces trois plans reste inchangée.
montage par coulissement Montage dans lequel les positions des points de départ et d’arrivée 
d’un plan du projet sont modifiées simultanément sans modifier la position ou la durée du plan. 
Ce processus est communément désigné par le terme coulissement, car vous faites coulisser les 
points de départ et d’arrivée du plan au sein du métrage disponible. La partie du plan visible 
dans le projet change, mais pas la position du plan dans la timeline.
collection intelligente Lorsque vous recherchez des plans dans un événement à l’aide de la 
fenêtre Filtre, vous pouvez enregistrer vos résultats en créant une collection intelligente qui 
regroupe les plans correspondant aux critères de recherche. Chaque fois qu’un nouveau plan, qui 
satisfait les critères de recherche de la collection intelligente, est ajouté à l’événement, il est aussi 
automatiquement ajouté à celle-ci. Les plans qui s’affichent dans les collections intelligentes ne 
sont pas dupliqués. Les collections intelligentes filtrent des plans dans un événement pour vous 
aider à vous centrer sur les plans dont vous avez besoin pour une tâche spécifique.Glossaire 497
magnétisme Lorsque le magnétisme est activé dans Final Cut Pro, les éléments que vous 
déplacez dans la timeline (notamment la tête de lecture, le skimmer et les plans sélectionnés) 
semblent se caler directement sur certains points de celle-ci. Cette fonction peut vous aider à aligner rapidement les montages sur d’autres éléments du projet. Le magnétisme affecte les fonctions de nombreux outils de montage dans Final Cut Pro, notamment les outils de sélection, Trim, 
Position, Sélection de plage et Lame de rasoir. Vous pouvez désactiver le magnétisme lorsqu’un 
montage de précision image par image s’avère nécessaire.
effets sonores Données audio spécifiques, telles que le son d’une porte qui se ferme ou d’un 
chien qui aboie, provenant de bibliothèques d’effets ou de plans que vous avez enregistrés. Les 
effets sonores peuvent être utilisés pour remplacer des sons dans l’audio d’un programme ou 
pour ajouter un son qui n’a pas été enregistré initialement.
fichiers multimédias source Fichiers d’origine (vidéo, audio et images fixes ou graphismes) que 
vous importez dans Final Cut Pro. Un plan utilisé dans Final Cut Pro pointe sur l’emplacement où 
le fichier de média source est stocké (soit sur un disque, soit sur un caméscope, une caméra ou 
autre appareil). Les modifications apportées aux plans dans Final Cut Pro n’influent pas sur les 
fichiers de média source.
effets spéciaux Effets visuels appliqués aux plans et aux projets, comme par exemple des effets 
d’animation, de compositing, d’incrustation et de resynchronisation.
élagage L’élagage est une opération d’étalonnage appliquant la couleur complémentaire 
(opposée) de la couleur rendue transparente pour neutraliser les franges bleues ou vertes ou 
la réflexion de la lumière qui teinte le sujet incrusté. Les commandes du curseur de Niveau de 
débordement contrôlent le degré d’élagage appliqué au sujet incrusté.
montage scindé Final Cut Pro permet de définir des points de départ et d’arrivée distincts pour 
les données vidéo et audio dans un plan individuel. Ces montages, connus sous le nom de montages scindés, représentent une technique courante dans la plupart des scènes de dialogue dans 
les films et les programmes télévisés. Vous pouvez utiliser les montages scindés pour introduire 
le son d’un plan avant l’entrée de la vidéo du plan en question ou de la scène correspondante. 
À l’inverse, vous pouvez faire appel à un montage scindé pour étendre l’audio d’un plan sur le 
plan suivant.
définition standard (SD) Fait référence aux tailles d’image vidéo NTSC et PAL d’origine. NTSC 
exploite 480 ou 486 lignes actives par image ; PAL, pour sa part, fait appel à 576 lignes actives. 
Voir aussi haute définition (HD).
stéréo Abréviation de stéréophonique. Audio comportant deux canaux différents. Les modifications du niveau sonore sont automatiquement apportées aux deux canaux simultanément. 
scénarios Toutes les instances de la timeline comportent un scénario principal, qui est la 
séquence de plans principale que vous constituez pour créer votre film. Les scénarios constituent 
des séquences de plans connectés au scénario principal. Vous pouvez utiliser les scénarios aux 
mêmes fins que les plans connectés (comme par exemple pour créer des plans de coupe, des 
titres composites et d’autres graphismes, ou pour ajouter des effets sonores et de la musique).
coupe droite Coupe dans laquelle les éléments vidéo et audio sont coupés en même temps.
sous-image Une sous-image a une durée égale à 1/80 de celle d’une image vidéo et constitue 
donc une unité de référence plus précise lors du montage de l’audio au niveau des échantillons.Glossaire 498
synchro (synchronisation) Relation entre l’image d’un son créé dans un plan vidéo (par 
exemple, les propos d’une personne) et le son correspondant dans un clip audio. La synchronisation audio est essentielle lors du montage d’un dialogue. Dans Final Cut Pro X, les plans connectés et les plans composés vous aident à maintenir la synchronisation dans votre programme.
navigateur de thèmes Navigateur multimédia de Final Cut Pro permettant d’accéder à 
l’ensemble des transitions et des effets de titre fournis avec Final Cut Pro, regroupés en 
thèmes connexes.
montage à trois points Technique de montage dans laquelle trois points de montage sur quatre 
sont définis dans une sélection source et un projet. Lorsque le montage est effectué, le quatrième point de montage est calculé automatiquement par Final Cut Pro.
Coupe Point de montage dans lequel le contenu vidéo ou audio d’un côté ou d’un autre du 
point de montage est continu.
TIFF (Tagged Image File Format) Format de fichier graphique bitmap très répandu, développé 
par Aldus et Microsoft, et gérant le monochrome, les niveaux de gris et les couleurs 8 et 24 bits. 
Ce format peut contenir des canaux alpha. Voir aussi canal alpha.
timecode Signal enregistré avec la vidéo et identifiant chaque image de manière unique. Par 
défaut, le timecode apparaît dans Final Cut Pro sous la forme heures: minutes: secondes: images. 
Il prend en charge un grand nombre de fonctions dans Final Cut Pro, notamment la lecture de 
timeline, la synchronisation des éléments de plans vidéo et de clips audio, le parcours de projets 
sur la timeline, ainsi que le déplacement et le trim appliqué à des plans.
timeline La partie inférieure de la fenêtre de Final Cut Pro contient la timeline, où vous créez 
votre projet de film en ajoutant et en organisant des plans, et en effectuant tous vos montages.
index de la timeline Vous pouvez afficher une liste chronologique textuelle des plans, mots-clés 
et marqueurs d’un projet à l’aide de l’index de la timeline. Lorsque vous sélectionnez un élément 
dans l’index de la timeline, la tête de lecture accède directement à l’élément en question sur 
la timeline.
teinte Nuance de couleur ajoutée à une image, généralement pour créer un effet, comme par 
exemple l’effet sépia.
navigateur de titres Navigateur multimédia de Final Cut Pro permettant d’accéder à tous les 
effets de titre inclus dans Final Cut Pro.
barre d’outils La barre d’outils est un ensemble de boutons et d’outils situés au centre de la 
fenêtre principale de Final Cut Pro. La barre d’outils comprend également le panneau de contrôle 
chargé d’afficher le timecode relatif au plan sélectionné dans le navigateur d’événements et à 
l’emplacement de la tête de lecture sur la timeline.
transcoder Tous les fichiers multimédias utilisent un format. DV, H.264 et MPEG-2 sont des 
exemples de format vidéo. Les fichiers vidéo présentent également de nombreuses propriétés, 
comme par exemple la taille d’image et la fréquence d’images vidéo, le débit des données et 
la fréquence d’échantillonnage audio. Si vous êtes amené à convertir un fichier de média dans 
un autre format ou modifier ses propriétés, vous le transcodez en fait dans le nouveau format 
ou transcodez ses propriétés. Compressor, une application Apple conçue pour fonctionner avec 
Final Cut Pro, effectue le transcodage des fichiers de média en un processus rapide et simple.Glossaire 499
transitions Effets visuels appliqués à des points de montage afin d’atténuer le passage d’un plan 
un autre. Dans Final Cut Pro, vous pouvez choisir parmi différentes transitions vidéo, telles que les 
fondus ou les balayages, ou ajouter un fondu enchaîné entre des clips audio.
navigateur de transitions Navigateur multimédia de Final Cut Pro permettant d’accéder à 
toutes les transitions vidéo incluses dans Final Cut Pro.
trim Après avoir grossièrement assemblé vos plans dans l’ordre chronologique dans la timeline, 
vous pouvez commencer à ajuster le point de montage entre chaque paire de plans contigus. 
Toute opération de rallongement ou de raccourcissement d’un plan dans un projet représente 
une opération de trim sur le plan en question. Ceci étant dit, le trim constitue généralement un 
ajustement précis (qui s’applique aussi bien à une image qu’à plusieurs secondes du plan). Si 
vous modifiez la durée d’un plan en manipulant des durées plus longues, il s’agit toujours d’opé-
rations de trim, bien que cela ne s’inscrive pas encore dans la phase d’affinement du montage. 
Dans Final Cut Pro, vous pouvez passer par un grand nombre de techniques pour effectuer le 
trim de plans et de points de montage sur la timeline, notamment les montages Ripple, Roll, par 
coulissage et par glissement.
outil Trim Outil de montage permettant d’appliquer un trim à des éléments dans la timeline. 
Pour activer l’outil Trim, appuyez sur la touche T.
4:2:2 8 et 10 bits sans compression Ces formats vidéo permettent de stocker de la vidéo Y’CbCr 
4:2:2 8 bits ou 10 bits sans faire appel à la compression de données. En contournant la phase 
de compression, la charge de traitement de l’ordinateur s’en voit réduite mais cela augmente 
considérablement le débit des données. Un système de stockage RAID de grande capacité est 
généralement nécessaire pour travailler de façon efficace avec de la vidéo sans compression. 
Dans de nombreux cas, le format Apple ProRes s’avère particulièrement adapté. Le débit des 
données vidéo 4:2:2 sans compression varie en fonction de la dimension image et de la fré-
quence d’images. Par exemple, une dimension image de 1920 x 1080 et une fréquence d’images 
de 29,97 ips supposent un débit des données de 1,0 Gbit/s pour de la vidéo 4:2:2 8 bits sans 
compression et de 1,3 Gbit/s dans le cas de la vidéo 4:2:2 10 bits sans compression.
case de valeur Une case de valeur est un type de commande numérique qui s’affiche sous 
forme de nombre, souvent à droite du curseur de base. Il existe deux façons de régler une case 
de valeur : faire glisser le nombre pour réduire ou augmenter le paramètre ou double-cliquer sur 
le nombre et saisir une nouvelle valeur.
vitesse variable Vitesse qui varie de manière dynamique, en avant ou en arrière, dans un 
même plan.
VCR Abréviation de VideoCassette Recorder (magnétoscope). Désigne généralement un appareil 
grand public utilisé pour enregistrer de la vidéo à partir de sources variées. Parfois appelé VTR. 
Voir aussi VTR.
vecteurscope Instrument vidéo de Final Cut Pro indiquant la distribution de la couleur dans 
votre image sur une échelle circulaire. Le vecteurscope est utile pour comparer la teinte et l’intensité des couleurs entre deux plans à des fins d’étalonnage.
Éditeur d’animation vidéo Vous pouvez afficher l’éditeur d’animation vidéo pour des plans dans 
la timeline afin d’ajuster les paramètres des effets, de créer des fondus entrants ou sortants, ou 
de changer les effets dans le temps à l’aide d’images clés.
Visualiseur Lorsque vous lisez des plans sélectionnés dans le navigateur d’événements et la 
timeline, ils s’affichent dans le visualiseur.Glossaire 500
VTR Abréviation de VideoTape Recorder (enregistreur de bande vidéo). Désigne généralement le 
matériel professionnel utilisé pour enregistrer de la vidéo à partir de différentes sources.
filigrane Incrustation graphique ou textuelle visible appliquée à une image ou à un plan vidéo 
pour indiquer qu’il ou elle est protégé(e) par la loi sur les droits d’auteur. Les filigranes servent 
à décourager l’usage d’images ou de plans vidéo sans l’autorisation explicite du détenteur des 
droits d’auteur.
WAVE (ou WAV) Format de fichiers audio le plus couramment utilisé pour stocker des données 
audio LPCM (linéaires à modulation d’impulsion codée) sans compression.
oscilloscope Instrument vidéo de Final Cut Pro affichant les niveaux relatifs de luminance et de 
chrominance dans le plan examiné. Les crêtes et les creux des formes d’onde affichées correspondent aux tâches lumineuses et aux zones sombres de votre image.
écran large Présentation de n’importe quel film avec des proportions plus larges que 4:3. Dans 
les salles de cinéma, 1,85 est considéré comme la norme et 2,40 comme une projection sur 
écran large. Pour la vidéo, 4:3 est considéré comme la norme et 16:9 (qui présente quasiment les 
mêmes proportions que 1,85) est considéré comme écran large. Voir aussi 4:3, 16:9.
balayage Type courant de transition vidéo. Dans un balayage, les scissions de l’écran se 
déplacent d’un côté de l’image à l’autre pour révéler progressivement le plan suivant. Cette transition s’avère plus voyante (mais aussi plus personnalisable) que le fondu ou le fondu enchaîné.
XDCAM Format de disque optique de Sony pour l’enregistrement de vidéo DVCAM et IMX dans 
des fichiers conteneurs MXF. Voir aussi DVCAM, IMX.
XDCAM EX Format de la famille XDCAM de Sony utilisant la compression vidéo MPEG-2 avec 
sous-échantillonnage de chrominance 4:2:0. Contrairement au format XDCAM HD, le format 
XDCAM EX prend en charge la vidéo 720p et permet l’enregistrement en pleine résolution HD 
(1920 x 1080 ou 1280 x 720). Son débit de données maximum est de 35 Mbps. Au lieu de disques 
optiques, les caméscopes XDCAM EX utilisent des cartes mémoire flash également appelées 
cartes SxS. Voir aussi HDV.
XDCAM HD422 Format de la famille XDCAM de Sony utilisant le sous-échantillonnage de chrominance 4:2:2 pour un débit vidéo de 50 Mbps. À l’instar du format XDCAM EX, il fait appel à la 
compression vidéo MPEG-2 en pleine résolution HD (1920 x 1080 ou 1280 x 720). Voir aussi HDV.
Y’CbCr Espace colorimétrique dans lequel de nombreux formats vidéo numériques stockent 
des données. Trois composantes sont stockées pour chaque pixel : une pour la luminance (Y) et 
deux pour les données de couleur (Cb pour les nuances bleues et Cr pour les nuances rouges). 
Également appelé YUV. Voir aussi pixel.
outil Zoom Outil de montage permettant d’effectuer un zoom avant ou arrière sur la timeline. 
Pour activer l’outil Zoom, appuyez sur la touche Z.
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Figures, Tables, and ListingsXcodeistheintegrateddevelopmentenvironment (IDE)designedfordevelopingiOSand Macapps.TheXcode
IDE includes editors used to design and implement your app, such as a source code editor and a user interface
editor. Xcode also supports multiperson development using source control management (SCM) systems. As
you write source code, Xcode can show you mistakes in both syntax and logic, and even suggests fixes.
Xcode features a single window, called the workspace window, that holds most of the data you need.
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Read this guide to get started using Xcode.
At a Glance
Xcode has many features to make your job easier:
● Single-window interface. You perform most of your development workflows in one window (you can
have multiple workspace windows and multiple tabs per window).
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About Xcode● Graphical user interface design.WiththeXcodeuser interface editor, calledInterfaceBuilder, youspecify
most of the details of your app user interface, such as the layout of the user interface controls, and their
connection to your app business logic and the data it manages, using a powerful and intuitive graphical
user interface. Interface Builder works closely with other editors, such as the source code editor, to take
you from design to implementation as fast as possible.
● Assisted editing. When you need to work on different aspects of the same component, such as user
interface layout and the implementation of the user interface functionality, you can use multiple editors
that open the content you need when you need it. For example, when you work on an implementation
file in the primary editor, Xcode can open the corresponding header file in a secondary editor pane.
● Automatic error identification and correction. Xcode checks the source code you type as you type it.
When Xcode notices a mistake, the source code editor highlights it. You can then find out details about
the error and ask Xcode to fix it for you.
● Source control. You can safeguard all your project files in Git and Subversion source code repositories.
Get Oriented to Xcode Organization and Features
Xcodeisapowerful tool,butas withany complexproduct, youneedtoknow essential conceptsand workflows
before you can start developing products efficiently.
Relevant Chapters: "Get Oriented" (page 15), "Start a Project" (page 56).
Design the Look and Behavior of Your App
Two of the most important tasks you perform while you develop your app are designing its user interface and
writing the business code that implements your app’s unique functionality.
Relevant Chapters: "Edit User Interfaces" (page 78), "Edit Source Code" (page 110).
Debug and Refine Your Code
Xcode provides a debugging environment that you can customize to automatically bring forward the parts of
your code in which you are most interested.
About Xcode
At a Glance
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13Relevant Chapters: "Debug and Tune Your App" (page 171), "Make Projectwide Changes" (page
209).
Safeguard Your Projects Using Source Control
Xcode provides easy local backups with snapshots and the ability to work in a team using SCM.
Relevant Chapters: "Save and Revert Changes to Projects" (page 245).
See Also
Todevelopapps fordistributiononthe AppStore, youmust configure yourdevelopment environment so that
youcaninstall your appsoniOSdevices anddistribute themtoapptesters. SeeApp Distribution Guide tolearn
more.
About Xcode
See Also
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14When you’ve got yourprojects open inXcode, you can start writing code. This chapterdescribes where to find
themost commonlyusedfeaturesofXcode. Theremainingchaptersdescribetheuseofsomeof thesefeatures
in more detail.
Contextual Help: Your Shortcut to Answers
In addition to being listed in the Xcode documentation browser, contextual help is available from shortcut
menus throughout the IDE. Control-click in any of the main user-interface areas in the workspace or Organizer
windows to see a list of help articles available for that area. Figure 1-1 shows contextual help for the source
editor. If there aremore articles thancanbe listedinthe shortcutmenu, choose Show All HelpTopics; thehelp
opens in the Organizer window. You can use contextual help to find information about a specific task, or just
to learn what tasks can be performed using a particular area of the Xcode user interface.
Figure 1-1 Contextual help
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Get OrientedThe Workspace Window: Where You Get Most of Your Work Done
Before going any further, you need to get oriented to the Xcode workspace window (Figure 1-2).
Figure 1-2 The navigator area in the workspace window
The left side of the window is the navigator area, opened to the project navigator in the figure. The project
navigator shows the contents of your project or workspace.
The right side of the window in Figure 1-2 is the editor area. You can edit many types of files, including source
code, property lists (plists), Core Data models, and user interface (nib or storyboard) files, and you can view
many more.
Get Oriented
The Workspace Window: Where You Get Most of Your WorkDone
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16Tosupplement theinformationintheeditorarea, youcanopentheutilityareaintherightsideof the workspace
window (Figure 1-3), which includes inspectors and libraries. Use the view selector ( ) in the toolbar
to switch between the navigator, debug, and utility areas.
Figure 1-3 The utility area in the workspace window
Get Oriented
The Workspace Window: Where You Get Most of Your WorkDone
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17When you run an app from Xcode, the debug area opens (Figure 1-4). When you stop at a breakpoint, the
debug navigator opens as well.
Figure 1-4 The debug area in the workspace window
Open Work in Tabs and Windows
For fast switches between different editors or files, you can add tabs to the Xcode workspace window, or you
can open additional windows. To activate tabs, choose View > Show Tab Bar, or add a new tab by choosing
File > New > Tab. To open a new workspace window, choose File > New > Window. You configure each tab
or workspace window independently of the others. For example, you can use one window to debug and
another to edit source code. If you open the same file in two tabs or two windows, the changes you make in
one tab or window are reflected in the other.
You can reorder tabs, close them independently, or drag them out of the tab bar to create a window, just as
you can do in Safari. You can use items in the Window menu (or their keyboard equivalents) to move between
tabs. You can also give a tab a name for use in Behaviors preferences (see "Customize Your Build and Run
Workflow" (page 155)).
Xcode remembers the windows and tabs you had open when you last closed a workspace and reopens them
in the same configuration when you start Xcode.
Work with the Files in Your Workspace
The project navigator shows projects, groups, folders, and files:
Get Oriented
The Workspace Window: Where You Get Most of Your WorkDone
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18● The project or projects in your workspace window are the highest level of the hierarchy in the project
navigator. Open the project’s disclosure triangle to see the groups, folders, and files in the project. Select
a project to view project information about the project in the project editor.
● A group appears in the project navigator as a yellow folder icon. A group collects files in the project but
does does not represent a folder on disk. Although you can organize your project in Xcode to reflect the
organization of files on disk, moving files into and out of groups does not affect the content of the folders
on disk.
● A folder is a reference to a folder on disk and appears in the project navigator as a blue folder icon. The
contents of the folder in the project navigator reflect the contents of the folder on disk. It’s important to
note,however, that thefilesthat appear ina folder iconintheprojectnavigator arenotpartof yourproject
unless youhave addedthemtotheproject explicitly (in whichcase they appeardirectlyunder theproject
or in a group, as well as in the folder). You can view and edit the files in a folder, but to move files in and
out of the folder you must use the Finder.
● A file in the project navigator is a reference to a file on disk.
Figure 1-5 shows a project (FolderFinder) containing both a group and a folder named ExtraFiles.
Although in the figure the group contains the same files as the folder, you could modify the contents of either
the group or the folder without affecting the contents of the other container.
Figure 1-5 A folder and groups in the project navigator
Get Oriented
The Workspace Window: Where You Get Most of Your WorkDone
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19To add existing files to a project
1. In the project navigator, select the project or group to which you want to add the files.
Note that you can’t add files to a folder in the project navigator. When you add a folder reference to
a project, changes you make to the contents of the folder in the Finder appear immediately in the
project navigator.
2. Choose File > Add Files to “”.
3. Select the file or files you want to add, and click Add.
If the file is not in your project folder on disk, you can choose to copy the file into your project folder.
If youselect a folder inthedialogandselect the“Createfolder referencesfor any addedfolders”option,
Xcode adds a folder reference to the project. Although the project navigator shows the files that are
in that folder on disk, Xcode does not add those files to your project. To add files in a folder to your
project, select the files individually, or select the “Create groups for any added folders” option.
Click the New Folder button to add a folder to the disk and a reference to that folder to the project
navigator. Doing so does not add any files to your project.
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20You can use the project navigator to organize the files in your project into groups and to list the files and
groups in any order you like. Jump bars in editor panes (such as the primary editor pane or assistant editor
panes) show the same organization that the project navigator displays, down to the file that’s open in the
editor. Editors such as the source editor show additional elements within the file, such as methods and user
interface objects.
Click the name of a file in the project navigator to see the file in the primary editor pane. The type of editor or
viewer that displays the file depends on the type of file you select.
To create a group
Do one of the following:
● Place the pointer at the location in the project navigator where you want the group, Control-click, and
choose New Group from the shortcut menu. You can drag files into the group, and you can drag the
group to a new location in the navigator.
● Select the files that you want to place in a new group, Control-click, and choose New Group from
Selection. Note that you can Command-click items in the navigator to get a discontinuous selection.
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21Click the name of the group to edit the name.
The project navigator has filters for recently edited files, files with source control status, unsaved files, and
filename strings. Figure 1-6, for example, shows a project filtered to show only implementation (.m) files. The
filter field and buttons are at the bottom of the navigator area.
Figure 1-6 The project navigator filtered to show only .m files
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22When you navigate to a file in the project navigator, the jump bar in the primary editor pane shows the path
to that file (Figure 1-7).
Figure 1-7 Project navigation
You can use the jump bar to navigate through your project.
Use a jump bar to directly navigate to items at any level in your workspace.
To use the jump bar
1. Click a level in the jump bar and choose a file to jump to.
2. To open a related file in Assistant, hold down Option and choose that file.
3. In the Assistant jump bar, choose a category of related files.
4. Use the stepper arrows to advance to the desired file.
5. Click the lock button to open a locked file, if appropriate.
See the HTML version of this 
document to view the video. document to view the video.
Get Oriented
The Workspace Window: Where You Get Most of Your WorkDone
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
23A jump bar is an interactive, hierarchical mechanism for browsing items in your workspace. Each editor
area includes a jump bar, as do Interface Builder and the documentation organizer. The configuration and
behaviorofeachjumpbar is customizedfor thecontext in whichit appears.Thebasic configurationincludes
three components:
●
Therelateditemsmenu( )offers additionalselectionsrelevant inthecurrent context,suchasrecently
opened files or the interface (.h) file for an implementation (.m) file you are editing.
●
Previous/next buttons ( ) allow you to step back and forth through your navigation history.
●
Thehierarchicalpathmenu(forexample, )
comprises one or more segments. Click a segment to choose from the menu of the items at that level
of the hierarchy.
Anexampleof abasic jumpbar isinthedocumentationorganizer. Itsimply allows youtoselectdocuments
from installed libraries. Other jump bars have more components.
A jumpbar may also include a stepper for iterating through a set of files ( ) or issues. If a lockbutton
( ) appears, you can click it and authenticate to unlock the file, if appropriate.
Hold down the Option key when selecting an item in the navigation bar to open Assistant and display that
item in the Assistant editor pane. In the Assistant jump bar, the path menu is rooted relative to the content
of the regular editor pane, and the root element (flagged with a light-bulb icon) offers selections similar to
a related items menu.
The video shows using the jump bar to view the class SKTCircle and then using the Assistant jump bar
to view its superclasses.
Tip: Hold down the Command key when selecting a level in the path menu to view its items
alphabetically.
Note that every element in the path in the jump bar is a pop-up menu that you can use to navigate through
your project. Hold down the Option key when selecting a file in the jump bar to open the file in an assistant
editor pane (you can change this behavior in the General pane of Xcode preferences).
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24The contentsof aneditor jumpbardependonthe typeof fileopeninthe editor.Wheneditingauser interface
file, for example, you can use the jump bar to navigate to individual user interface elements (Figure 1-8).
Figure 1-8 The Interface Builder jump bar
The jump bar also has back and forward buttons for moving through previously viewed files, and a pop-up
menu ( ) that displays a variety of useful information about related items, as shown in Figure 1-9.
Figure 1-9 The related items pop-up menu
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25Find Information to View or Edit
Xcode provides two ways to navigate through your project: navigators and jump bars. Most of the navigators
includetext fieldsforsearchingthroughtheprojector filteringtheitemsinthenavigator;someincludebuttons
to restrict the scope of items displayed. Jumpbars appear at the topofprimary and assistant editorpanes and
provide an alternate way to navigate through the files and symbols in the project. Because jump bars are
always available, you can use them to find items in the project even when the navigator area is closed.
Use the navigator selector bar at the top of the navigator area to display a navigator (Figure 1-10).
Figure 1-10 The navigator selector bar
Symbol Issue Breakpoint
Project Search Debug Log
These are the navigators in the navigator area:
● Project navigator
● Symbol navigator
● Search navigator
● Issue navigator
● Debug navigator
● Breakpoint navigator
● Log navigator
This section introduces most of these navigators, and describes how to jump directly to a file with jump bars.
("Work with the Files in Your Workspace" (page 18) describes the project navigator.) When you need help
using a displayed navigator, Control-click in the navigator to get a list of help articles that further describe the
use of the navigator.
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26Browse Project Symbols with the Symbol Navigator
Note that youneedto waituntilXcode finishesindexingyourprojectbefore youcanuse the symbolnavigator.
To browse the class hierarchy
Do one of the following:
● Display symbols in a hierarchical or flat list using the buttons at the top of the symbol navigator.
Refine which symbols are displayed using the filter bar buttons at the bottom of the navigator. Filter
buttons are blue when the corresponding filter is active and black when the filter is inactive:
● The Class button:Shows classes andtheirmembers, includingprotocols, functions,structs,enums,
unions, types, and globals.
● The Project button: Shows only symbols defined in the project or workspace.
● The Method button: Shows containers, hiding symbols defined within them such as methods,
properties, and variables.
● Filter field: Shows items that match the text entered.
Select a symbol to display its header file definition in the source editor.
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27Figure 1-11 shows one filter active and the text drawing in the filter field. In the resulting list, the
bezierPathForDrawing method is selected and its definition is highlighted in the primary editor
pane.
Figure 1-11 Browsing the class hierarchy with the symbol navigator
● Click an element in the jump bar to see a list of symbols at that level in the project hierarchy, as shown
in Figure 1-12.
Figure 1-12 Browsing the class hierarchy wiht the jump bar
Tip: Hold down the Option key when selecting a file in the jump bar to open the file in an assistant
editor pane (you can change this behavior in the General pane of Xcode preferences).
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28Find Text Strings with the Search Navigator
Find text strings in your project or workspace with the search navigator.
Search a workspace or a find scope for text that matches specific criteria.
To search for text in projects and frameworks
1. In the search field, enter the search term.
2. Specify the find criteria.
3. Specify the find scope.
4. Press Return.
5. If desired, refine the results by entering a filter term in the filter field.
Use the find criteria to specify the style (textual or regular expression), attributes, and capitalization of the
text to find.
Use the find scope to confine your search to a particular location or set of files.
Use a filter term to remove any results that do not match it from the search list.
The screenshot shows the find criteria and find scope areas open, and search results for NSArray filtered
by the text circle.
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29Tip: Option-click a search result to see it displayed in an assistant editor pane.
To customize the search, click the magnifying glass in the search field and choose Show Find Options. You can
specify the type of text and the scope of the search.
You can also replace text you’ve found. See "Replace Text Strings" (page 209) for details.
Investigate Problems in your Project with the Issue Navigator
The issue navigator lists messages, warnings, and errors that Xcode identifies in your code and your project,
including issues found by Fix-it, the static analyzer, and the compiler.
When a build fails, the issue navigator opens, displaying the problems found in the project. Select an issue to
see it displayed in the primary editor pane. You can also navigate through the issues using the arrows and
pop-up menu at the right endof theprimary editor jumpbar. See "Locate and Display BuildIssues" (page 173)
for more information on the issue navigator.
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30View Threads and Stacks in the Debug Navigator
When your running code hits a breakpoint (or you use the debug bar in the debug area to pause execution),
thedebugnavigator shows the current stateof the stack ineachrunningthread. Click aniteminthenavigator
to see it in your source code and to see the values of variables in the debug area.
Formore informationonusingthedebugnavigator whiledebuggingyour code,see "Examine Threads, Stacks,
Variables, and Memory" (page 190).
Manage Breakpoints with the Breakpoint Navigator
Whereas you set breakpoints in the source editor, the breakpoint navigator is where you can see all your
breakpoints in one place. In addition, you use the breakpoint navigator to add conditions and options to
breakpoints.
For more information on using breakpoints in debugging your code, see "Manage Breakpoints" (page 177).
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31View Build, Source Control, and Debug Session Logs with the Log Navigator
When you perform an operation that is normally recorded, such as building or analyzing your code, or that
has output to the console, such as a source control operation or a debug session, the record of that operation
is listed in the log navigator. Select an item in the log navigator to see the log in the editor pane.
You can use the filter button and text field at the bottom of the navigator to limit the logs displayed to recent
logs or logs whose names match the text string you enter.
The log viewer has two distinct displays:
● For noninteractive tasks, such as building and source control, the log viewer displays a scope bar that you
can use to specify the content to display, such as all messages or only errors (see Figure 1-13).
Figure 1-13 Viewing a log
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32Successfuloperationshaveagreencheckmark iconnext tothem. Operations with warningshavea warning
icon (an exclamation mark in a yellow triangle). Operations with errors have an error icon (an exclamation
mark in a red octagon) next to them. The right side of the operation indicates the number of warnings
and errors the operation produced.
To view an operation’s warning or error messages, click the disclosure triangle on the left side of the
operation.
To view an operation’s transcript, click the transcript button ( ) on the right side of the operation.
● For interactive tasks, such as debugging sessions, the log viewer displays a transcript of the session.
Edit and View Many Types of Data
Xcode includes editors for many types of data, including:
● User interface files
● 3D scene files
● Source code files
● Property list files
● Rich text files
● Core Data models
● Core Data mapping models
● Project and build settings
● AppleScript files
● Scripting dictionary files
Xcode also has viewers that can display graphics, videos, and a variety of other file types. Control-click in an
editor to get help using it.
A file for which Xcode does not have an editor is displayed using Quick Look. (Quick Look is also used by the
Finder. In the Finder, select a file and press the Space bar or choose Quick Look from the File menu to see it
in use.)
Eachdocument-typeeditorhas customcommandsinthe NavigateandEditormenustoactontheinformation
in that type of document. Note that the Navigate menu—like several of the menus in Xcode—shows different
menu items when you hold down the Option, Shift, or Option and Shift keys.
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33Edit User Interface Files
Interface Builder is the editor you use to edit user interface documents (nib files). With this editor you design
the user interface of your app by adding user interface controls from a library and by specifying properties for
those controls, such as their behavior and their position in a view.
For more information on editing user interfaces with Interface Builder, see "Edit User Interfaces" (page 78).
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34Edit Source Code Files
The source editor has many features to help you develop source code. Among other features, you can write
and edit source code (see "Edit Source Code" (page 110)), set and enable or disable breakpoints (see "Manage
Breakpoints" (page 177)), and control program execution during a debugging session (see "Control Program
Execution" (page 185)). Control-click in the source editor to see a list of help topics describing features of the
editor and tasks you can accomplish (Figure 1-1 (page 15)).
Figure 1-14 The source editor
Note: When you edit a file in Xcode, the file’s icon is shaded in the project navigator to indicate
that there areunsavedchanges.Youcansave the file,or if youquitXcodeorbuildtheproject,Xcode
automatically saves all changedfiles for youbydefault (you can change thisbehavior in the General
paneofXcodepreferences).Toensureyoucanreturntoa knownstatebeforeyoubuildyourproject,
create a snapshot (see "Take a Snapshot of Your Project" (page 246)).
Edit in Hexadecimal Format with the Hex Editor
You can view most file types in hexadecimal format by Control-clicking the file in the project navigator and
choosing Open As > Hex from the shortcut menu. Some file types that are not editable in the default viewer,
such as image files, can be edited in hexadecimal format.
You can edit the hexadecimal code directly, or you can edit in the plain text column. Editing either format
updates the other.
When the hex editor has focus, you can use the Editor menu to customize its display.
View and edit a file in its binary format by opening it in the hex editor.
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35To open a file with the hex editor
1. Control-click a file in the project navigator.
2. Choose Open As > Hex.
The hex editor has three areas:
● On the left, the line numbers
● In the center, the hexadecimal representation of the bytes in the file, 32 bytes per line, one byte per
column
● On the right, the plain-text (ASCII) representation of those bytes
From the Editor menu, you can hide the line numbers or theplain-text representation. You can also choose
to display the byte codes in groups of 2, 4, 8, 16, or 32.
The screenshot shows an image file in the hex editor.
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36Edit Project Information
When you click the project icon in the project navigator, the project editor appears to the right of the project
navigator, displaying project and target information. Figure 1-15 shows some of the target information in the
project editor.
Figure 1-15 Target information in the project editor
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37Click the Basicbuttontoview basicbuildsettingsor click the Allbuttontoview all settings. The valuesofbuild
settings can be set at the default, project, or target level. You can edit a build setting at the project or target
levels. Click the Levels button to see all the levels of build settings simultaneously, as in Figure 1-16. If you
have changed or customized a setting, it’s shown in boldface. Click the Combined button to see just the
resolved build settings.
Figure 1-16 Build settings in the project editor
See "To add a new build configuration" (page 71) for more information on using build settings.
Edit Property List Files
In addition to the Info.plist file required for every application, the property list editor opens a variety of
other property list file types.
To edit a key or a value, double-click the item and type a new string into the text field. In some cases, apop-up
menu is available, indicated by small vertical arrows. Click the arrows to see the choices.
You can add a new property or you can add a new child property for an array or dictionary. The property list
editor warns you if you attempt to add a key that already exists in the file.
Add a new property to a property list using the property list editor.
To add a property to a property list
1. In the property list editor, hold the pointer over an entry and click the Add (+) button.
2. Choose a key name from the pop-up menu.
Get Oriented
The Workspace Window: Where You Get Most of Your WorkDone
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
383. Choose a value from the pop-up menu in the Value column or enter a value.
If you are adding a property that is an array or dictionary, click the disclosure triangle and press Return to
add a child property.
You can add a property with a name that is not in the pop-up menu. To do so, type the key name in the
field at the top of the pop-up menu, choose the data type from the pop-up menu in the Type column, and
enter a value in the Value column.
Click the minus (–) sign next to any item to remove it from the file.
For known property list key types, the Key column in the property list editor shows the descriptive name of
the key instead of the key’s literal text. Choose Editor > Show Raw Keys & Values to display the literal text
instead. You can also see both the name and the raw key value in Quick Help in the utility area (Figure 1-17).
Figure 1-17 Quick Help for key values
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39Control-click in the editor and select Property List Type to see a list of possible file types for property lists. The
type of the current file is indicatedby adashto the left of the filename. You canuse thismenu to change from
the default to a specific property type.
Set the property list type when creating or editing a property list. If Xcode cannot determine the type of a
property list, you may need to set the type manually.
To set the property list type
1. Select a property list in the project navigator.
2. Control-click in the property list editor to display a contextual menu.
3. From the Property List Type submenu, choose a new property list type.
Property lists that share the same system-defined structure are said to have the same type. In addition to
the Info.plist file required for every application bundle, the property list editor in Xcode supports a
variety of other types. The property list type determines the list of possible keys in the key’s pop-up menu.
In the Property List Type submenu, the current type is indicated by a dash to the left of the type name.
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40Edit Rich Text Files
You can write, open, and edit rich text (.rtf) files in Xcode. The editor has a user interface and feature set
similar to those of the Mac OS X TextEdit application, but without the capability of converting the file to other
formats such as plain text or HTML. Note that Xcode opens plain text (.txt) files with the source editor, not
the rich text editor.
Edit Data Model Documents
If your project uses the Core Data framework, you can use the data model editor to implement or modify your
Core Data model (see Core Data Starting Point).
Get a jump-start on your Core Data-based project by using one of the project templates that incorporate Core
Data.
To create a project that uses Core Data
1. Choose File > New > Project.
2. Select the project template for your iOS or OS X product, and click Next.
3. If the Use Core Data option appears in the project options pane, select it and click Next.
Otherwise, Core Data is not available in the selected project template.
4. Enter the project name, and specify its location in your file system.
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415. Click Create.
The project templates that incorporate Core Data:
● Link against the Core Data framework
● Add a managed object model file
● Add code to create and locate the various parts of the Core Data stack
Use the Core Data model editor to edit the managed object model.
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42Important: Not all templates offer a Core Data option.
Core Data is an advanced technology that is not required for creating simple applications.
The managed object model is a representation of the schema that describes your model objects, including
the relationships between them. Figure 1-18 shows the data model editor.
Figure 1-18 The data model editor
The top-level components area lists the entities, fetch requests, and configurations defined in the model. You
can select one or more items at a time within a single group. Use the Add Entity button to add an entity, fetch
request, or configuration. To add a fetch request or configuration, press and hold the Add Entity button until
it shows the other options. The button retains the label from the last time it was used.
The detail area shows the attributes, relationships, and fetched properties associated with the item or items
you select in the top-level components area. You can select one or more items from the same group at the
same time. There are two styles for the detail area: table and graph. You select the style using the Editor Style
buttons at the bottom-right corner of the editor area. You can use the graph style only if you select an entity
inthetop-level components area.Youcanuseeitherstyletoedit themodel,however thetablestyleistypically
better for detailed editing and inspection, and the graph style is better for visualizing your schema.
The Core Data Model inspector in the utility area displays information about the item or items you select in
the detail area. By selecting more than one property in the detail area, you can edit several properties at the
same time. For example, you can set the Attribute Type for a number of attributes simultaneously.
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43Edit Core Data Mapping Files
If you change your Core Data model extensively enough that you need a mapping between an old store and
a new one, you can use the Core Data mapping model editor to graphically create the mapping model.
A Core Data mapping model describes the transformations needed to convert data described by a Core Data
model to another Core Data model with a different schema. The Core Data mapping model editor provides
table-based tools to create and edit a mapping model.
Tip: Before you create a mapping model, you should consider whether you can transform your data using
lightweightmigration(asdescribedinCoreDataModelVersioningandDataMigrationProgrammingGuide).
Lightweight migration is much simpler and more efficient than mapping model-driven migration. In some cases,
you can make custom transformations by first using lightweight migration, and then performing an additional
step in code.
The mapping model editor is shown in Figure 1-19.
Figure 1-19 The mapping model editor
Click the Add Entity Mapping button to display a series of dialogs that you use to configure the new mapping.
If necessary, choose the source and destination models for the entity using the corresponding pop-up menus.
For complete flexibility, youcanimplement a subclassofNSEntityMigrationPolicytoset it as the custom
policy for a mapping.
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44Standard Editing, Assisted Editing, and Versions Editing
Xcode provides three editing modes targeted for three particular editing workflows:
● Standard editing: Onedocumenteditorusestheentireeditingarea.Standardeditingisappropriate when
a single file or information type requires most of your attention.
● Assisted editing: Oneprimary editorpane andoneormore assistant editorpanesoccupy the editor area.
Assisted editing is useful when you work on more than one aspect of your project at the same time. For
example, use assisted editing when you are connecting user interface elements to implementation code.
You can display two or more different views of a file, or two or more files in the editor panes (side by side
or one above the other).
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45Although you can specify which file to show in each editor pane, it is often helpful to let Xcode find and
open a related file for you in assistant editor panes.
For more information about assisted editing, see "Split the Editor Area to Display Related Content" (page
120).
● Version editing: In version editing, the versions browser takes up the entire editor area. The versions
browser contains adocumenteditor foreditingyour versionof a file, adocument viewer for viewingearlier
versions of the file, and a version selector to select the version to view. Version editing mode is useful in
projects using source control management (SCM) when you want to compare your version of the file with
earlier versions.
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46For more information on the comparison editor, see "Compare Revisions" (page 272).
Find Information that Supplements the Primary Editor
The utility area contains two subareas: the inspector area and the library area. You use the inspector area to
view and set properties of the content open in the primary editor. The library area contains file templates you
can use to create files, code snippets you can add to your code, and user interface controls you can add to
your user interface files. You can also access all the media files in your project or workspace.
To open the utility area, choose View > Utilities.
View and Edit the Properties of Specific Items
Inspectors arepanesintheinspector areaof theutility area that youusetoreadorenterdata about thecontent
in the primary editor (which can be a file, and item in the file, or project information).
Which inspectors are available depends on the type of content open in the primary editor. However, two
inspectors are available for any content type: the File inspector and the Quick Help inspector.
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47Get File Templates, Code Snippets, User Interface Objects, and Media Assets
The library panes in the library area of the utility area provide file templates and code snippets that you can
drag into your project or workspace, user interface elements that you can add to your user interface files, and
the media files (graphics, sound files, and so forth) contained in your workspace.
For more details on the use of the libraries, see "Incorporate Files and Code from the Xcode Libraries" (page
136).
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48Check on the Progress of Xcode Tasks
Theactivityviewer inthe workspace window toolbarshowstheprogressofanytaskXcodeis currentlyexecuting.
If two or more tasks are currently underway, a small number appears at the left edge of the activity viewer
(Figure 1-20). Click thenumber to openapop-up window that shows the individual status of eachcurrent task
(Figure 1-21).
Figure 1-20 The activity viewer
Figure 1-21 The activity pop-up window
If Xcode finds issues in your workspace, an icon in the activity viewer indicates the number and severity of
issuesfound(Figure1-22). Click the issuesicontosee the issuesinthe issuenavigator,describedin"Investigate
Problems in your Project with the Issue Navigator" (page 30). .
Figure 1-22 Issues in the activity viewer
The Organizer Window: Manage Development Resources
Xcode has two main windows. You’ve seen the workspace window (Figure 1-2 (page 16)), used for editing,
debugging, and interface design. The other main window, called the Organizer window, displays information
about the devices you use for developing apps, source control repository information, project storage
information, information about your archives, and documentation.
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49To open the Organizer window, choose Window > Organizer.
Manage Development Devices in the Devices Organizer
Use the Devices organizer to manage your development devices and the digital assets you need to build apps
and install them on your devices. Click the Devices button in the Organizer window toolbar to display the
Devices organizer.
For details on managing development devices, see "Manage Your Devices" (page 219).
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50Manage Source Control Repositories in the Repositories Organizer
In the Repositories organizer you can create local repositories, connect to and manage repositories on servers,
andsoforth. Click theRepositoriesbuttoninthe Organizer window toolbar toopentheRepositoriesorganizer.
You perform many common SCM operations, such as submitting files, from the workspace window. See "Keep
Track of Changes with Source Control" (page 247) for details.
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51Manage Project Snapshots and Derived Data in the Projects Organizer
TheProjectsorganizer liststheprojectsand workspacesyouhaveopened.Youcanopenaprojector workspace
by double-clicking its name in the list on the left side of the organizer. By selecting a project or workspace in
the list, you can access its derived data and snapshots. Click the Projects button in the Organizer window
toolbar to open the Projects organizer.
To learn more about snapshots, see "Take a Snapshot of Your Project" (page 246).
Browse and Bookmark Documents
The Documentationorganizer isarepositoryofallof thedocumentationinyour library. Clickthe Documentation
button in the Organizer windows to open the Documentation organizer.
Get Oriented
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2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
52To browse documentation, open the Organizer window, click the Documentation button in the toolbar, and
click the Browse button at the top of the navigation pane (Figure 1-23).
Figure 1-23 The documentation navigator
Get Oriented
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53While reading any page of a document, you can choose Editor > Add Bookmark or Control-click and choose
Add Bookmark for Current Page to bookmark that page. Click the Bookmark button in the navigator pane to
see a list of bookmarks (Figure 1-24).
Figure 1-24 The bookmarks navigator
To select which documentation sets to download, use the Downloads pane in Xcode preferences.
To set documentation preferences
● Setpreferencesforupdatingdeveloperdocumentationusingthe Documentationtabof the Downloads
preferences pane.
Documentation is installedin the form ofdocumentation sets, often calleddoc sets. Appledoc sets for
key developer libraries are installed with Xcode, and access to updates for them is controlled by
subscription. For your convenience, Xcode can automatically keep these subscriptions up to date. This
feature is controlled by the option “Check for and install updates automatically,” which is selected by
default. If this option is selected, Xcode displays the date and time of the last check.
Get Oriented
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54Tocheck forupdatesmanually, click the“Check andInstall Now”button. Ifnonew updates areavailable,
Xcode displays a message to that effect. When an update for a doc set is available but not yet installed
on your system, Xcode displays an Install button on the subscription line for that doc set. Click that
Install button to download and install the updated doc set on your system.
To install non-Appledocumentation, subscribe to the associateddocumentation feed. First, obtain the
web (RSS) feed URL from the publisher. Click the Add (+) button, as shown in the figure, follow the
onscreen instructions to enter the URL, and click Add in the dialog.
To remove a doc set from your system, select the subscription entry for the doc set, then click the doc
set info button. Click the Installed Location link to show the doc set file in the Finder, then delete the
file from the Finder.
To unsubscribe from non-Apple documentation, select the subscription entry for the doc set, click the
Remove (-) button, and confirm the removal operation.
Note: You can remove an Apple doc set from your system, but you cannot remove the
subscription to its doc set feed.
At the bottom of the pane, you can set a minimum font size for Documentation organizer content by
selectingtheoption"Neveruse fontsizessmaller than," andthenchoosinga fontsize fromthepop-up
menu.
Get Oriented
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55This chapterdescribeshow tostart anew Xcodeproject,eitherby creatingaproject fromscratch,orbyopening
an existing project. When you’ve got your projects open, go to "Get Oriented" (page 15) to learn more about
using Xcode.
Create a Standalone Project
If you want to start a new software development undertaking using Xcode, you need to first decide whether
you needa single project or multiple relatedprojects. For a simple appor utility, a singleproject shouldsuffice.
However, if you have several related executables that need to link to a custom library, you probably want at
least a separate project for the library, and possibly a separate project for each executable.
Start developing a software product by creating a project. All software products require a project. The project
organizes the files and resources needed to build one or more products, such as applications, plug-ins, and
command-line tools.
To create a standalone project
1. Choose File > New > New Project.
2. Select the project template for your iOS or OS X product, and click Next.
3. Enter the product name and other project details, and click Next.
4. Specify the project’s location in your file system, and click Save.
See the HTML version of this 
document to view the video. document to view the video.
The New Project dialog displays platforms, template families, project templates, and a description for the
selected project template. In the project options pane you enter information required by the template to
generate the project, such as the product name.
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Start a ProjectNote: The New Project dialog appears in the workspace window for the workspace to which
Xcode will add the project. When you create a project with no workspace window active, the
New Project dialog is attached to a new workspace window that contains only the new project.
The project location in your file system and its container in the workspace window are both derived from
your selection in the project navigator when you initiated the New Project command. That is, if you have
a project selected in the project navigator, Xcode places the new project inside the selected project. The
Save dialog lets you specify a different location and container for the new project before completing the
operation.Forexample, youcanindicatethat thecontainerof theprojectbeagroup withinyour workspace
instead of the workspace itself.
The video shows how to create a project named MyProject and place the project directory on the Desktop.
Aftersavingtheproject,Xcodeplaces a folder containingthenew project’sfiles at thelocationyouspecified.
Once you’ve created a project, you can add new source files and begin writing code.
If you have two or more closely related projects, create a workspace and add your projects to it, as described
in "Create a Workspace to Work with Multiple Related Projects" (page 60).
Start a Project
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57Preconfigure the New Project
The new project dialog shows options tailored for the project’s platform (iOS or Mac) and product type (app,
plug-in, and so on). Figure 2-1 shows the options available for a new iOS project.
Figure 2-1 Options for a new iOS project
Use Storyboards
With storyboards, you design iOS user interfaces using scenes and scene transitions (known as segues). Each
scene contains a view controller and its view hierarchy. Scenes also have a parent-child relationship between
them, which specifies how one scene flows to another, and how data is transferred between scenes. Segues
specify the visual transition from one scene to another.
To use storyboards to design user interfaces in your project, select the “Use Storyboards” option.
See View Programming Guide for iOS for details about using storyboards.
Use Core Data
With Core Data, you design the data model of your app using a graphical entity-relationship editor. Note that
this is an advanced technology that is not required for creating simple applications. You can use Core Data in
iOS and Mac projects.
To use Core Data in your project, select the “Use Core Data” option.
Start a Project
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58See "Edit Data Model Documents" (page 41) for more information.
Use Automatic Reference Counting
Automatic Reference Counting (ARC) is a technology that automates memory management for Objective-C
objects. ARC makes memory management much easier, greatly reducing memory management problems in
your project.
To use Automatic Reference Counting, select the “Use Automatic Reference Counting” option.
For more information on ARC, see Transitioning to ARC Release Notes.
Use Unit Tests
Usingunit testsinyourprojecthelpsensurethat themodifications youmaketoyour codedonotbreakexisting
functionality. Unit tests are one of the essential building blocks of test-driven development.
To use unit testing in your project, select the “Include Unit Tests” option.
To learn more about unit tests, see Xcode Unit Testing Guide.
Start a Project
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59Create a Git Repository For Your New Project
You can create a local Git repository when you save the new project (Figure 2-2). This is the easiest way to add
source control to aproject (see "KeepTrack of Changes withSource Control" (page 247) formore information).
Figure 2-2 Creating a local Git repository when creating a project
Create a Workspace to Work with Multiple Related Projects
A major feature of Xcode is the ability to create a container for multiple projects that you can use to group
Xcode projects and other related files. This container is referred to as a workspace. All the projects in the
workspace share the same build directory. Putting your related projects in the same workspace affords you
several benefits, including:
● One project can use the products of another project while building.
● If one project depends on the products of another in the same workspace, Xcode can detect this and
automatically build the projects in the correct sequence.
● Because all the files in one project are visible to all the other projects in the workspace, you don’t need to
copy shared libraries into each project folder separately.
● Indexingisdone acrossthe entire workspace, extendingthe scopeof content-aware featuressuchas code
completion.
Start a Project
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60Start a multiproduct development endeavor by creating a workspace. A workspace serves as a common
container for several related projects.
To create a workspace
1. Choose File > New > New Workspace.
2. Enter the workspace name, and specify its location in your file system.
3. Click Save.
See the HTML version of this 
document to view the video. document to view the video.
Xcode uses the workspace to actively manage many explicit andimplicit relationships among the included
projects and their targets. For example, this capability lets you specify that when you build an application,
Xcode must build any products the application depends on, such as a library.
The video illustrates creating a workspace called MyWorkspace, saved on the Desktop.
Once your workspace is created, you can create new projects within it, and you can add existing projects
to it.
Youcanaddanexistingproject tothe workspace,or Control-click inthe structurenavigator below the existing
projects and choose New Project to create a project in the workspace.
Add an existing project to a workspace to add a product to a multiproduct development endeavor. When you
need to work on two or more related projects, you can add them to a workspace so that you can create
interproject relationships.
To add an existing project to a workspace
1. In the project navigator, Control-click in the empty space below the list.
2. Choose Add Files to “”.
3. Navigate into the folder containing the project package.
Start a Project
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614. Select the project package and click Add.
See the HTML version of this 
document to view the video. document to view the video.
For example, you can have a workspace with an application project, add a framework project to the
workspace, andmake the applicationdependentonthe framework.Whenyoubuildthe application,Xcode
builds the library first, if it needs to be built.
When adding a project to a workspace, you add the project package. A project package is a directory that
the Finder displays as a file. It contains information about the project, such as references to the files that
are part of the project, the project’s groups, build settings, and target definitions.
The video shows the process of adding a second project, called MyFramework, to a workspace called
MyWorkspace.
After you add a project to your workspace, the project appears in the project navigator.
Alternative: You can drag a project package from a Finder window or a workspace window to
the project navigator in a workspace window to add the project to the second workspace. When
doing so, ensure that you add the project package to the root of the project navigator and not
a project within it.
Note: If you choose File > New > Project while you have projects or workspaces open, you can use
the“Addto”pop-upmenuinthedialogtoaddtheproject toanyof theopenprojectsor workspaces.
Because each project retains its individual identity, a project can be included in more than one workspace or
removed from a workspace without affecting the project. The workspace file itself merely contains pointers to
theprojects andother files that the workspace includes,plus aminimal amountofdata suchas schemes stored
in the workspace. The pointers to the source files, included libraries, build configurations, and other data are
stored in the project files.
Start a Project
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62Tip: If you have an Xcode project and would like to create a workspace to contain it, choose File > Save as
Workspace. You can assign a new name to the workspace and specify a location for the workspace file. Doing so
does not alter the original project or prevent you from adding the project to another workspace as well.
If the build product of one project in a workspace is dependent on the build product of another project in the
workspace (for example, ifoneprojectbuilds a libraryusedby theotherproject),Xcodediscoverssuchimplicit
dependencies and builds in the correct sequence. If you don’t want one project to use the product or files in
anotherproject that’sinthesame workspace, youneedtoadjust yourbuildsettings accordingly.See"Configure
Your Project" (page 64) for help in finding and understanding the build settings interface in Xcode.
Before you build, be sure you’ve created the scheme or schemes you need. See "Customize Product
Actions" (page 161) for more information on schemes.
Check Out a Working Copy from Your Source Control Repository
If your Xcode project is in a Git or Subversion repository, you can check out your project from the repository
and open it in Xcode. See "Keep Track of Changes with Source Control" (page 247) for more information on
using source control in Xcode.
Close a Project or a Workspace
Choose CloseProjector CloseWorkspacefromtheFilemenutocloseaprojector workspace.Xcoderemembers
which windows youhadopenandhow they were configured, andrestores themwhenyoureopentheproject
or workspace.
Start a Project
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63This chapter describes how to specify product details by configuring projects.
General Configuration
This section describes configuration options that apply to all project types.
Update to Recommended Settings
When you open a project, Xcode evaluates it to determine whether there are any settings that should be
updated. This feature provides an easy way to make sure your projects conform to the latest SDKs and best
practices.
Open the issue navigator (Figure 3-1) to see whether anything in your project should be updated.
Figure 3-1 Validate Project Settings warning in the Issue navigator
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Configure Your ProjectIf the issue navigator lists the Validate Project Settings warning, click the warning to see a list of the
recommended changes (Figure 3-2). Deselect any changes you don’t want to change, then click the Perform
Changes button to update the project.
Figure 3-2 Project settings recommended changes list
After performing the changes, whether you choose to make all the changes or not, Xcode does not show the
warning again.
To validate project settings again, select the project in the project navigator and choose Editor > Validate
Settings.
Specify the Targeted OS Version
Each version of iOS and OS X (and its corresponding SDK) includes features and capabilities not present in
earlier versions. As new OS versions are published, some users upgrade immediately while other users wait
before moving to the latest version. You can take one of two strategies concerning the OS version to target
in developing your app:
● Target the latest OS version. Targeting the latest OS version allows you to take advantage of all the
features available in the OS, including newly introduced features. However, this approach means that a
smaller set of users is capable of installing your app on their devices because your apps cannot run on OS
versions that are earlier than the target version.
● Target an earlier OS version. Targeting an earlier OS version lets a larger set of users install your app.
However, targeting an earlier version may limit the operating system capabilities your app can use.
To specify the earliest OS version on which you want your app to run:
1. In the project navigator, select the project.
Configure Your Project
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652. From the target list in the project editor, select the target that builds your app.
3. Click Summary.
4. From the Deployment Target pop-up menu, choose the OS version you want to target.
When you build the app, your deployment target selection is reflected in the MinimumOSVersion entry in
the Info.plist file for the app. When you publish your app to the App Store, the store indicates the OS
version on which your app can run based on the value of this property.
Note: If the SDK you use to build the app is more recent than the app’s target OS version (for
example, thebaseSDKisiOS6.1andthedeployment target isiOS6.0),Xcodedisplaysbuild warnings
when it detects that your app is using a feature that’s not available in the targeted OS version.
You must also ensure that the symbols you use are available in the app’s runtime environment. To
check for their availability, use the techniques described in SDK Compatibility Guide.
Important: When building for a simulation environment, the generated binary runs only on the iOS
Simulator app that’s part of the Xcode toolset version used to build the binary. It does not run on earlier
or later versions of the iOS Simulator app.
Use Automatic Reference Counting
Objective-C Automatic Reference Counting (ARC), introduced in Xcode 4.2, automates memory management
for Objective-C objects. ARC makes memory management much easier, greatly reducing the chance that your
program will have memory leaks. Xcode can update a non-ARC project to ARC, or can assist you in doing so.
To add ARC to a new project, see "Preconfigure the New Project" (page 58).
Note: ARC requires the Apple LLVM compiler.
To update a project so that it uses ARC:
1. Select the project in the project navigator.
Configure Your Project
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662. Select the targets and source files you want to convert, and click the Check button.
3. Fix issues that prevent the conversion.
If thereareissuesthatprevent conversion,Xcodedisplays adialogindicatingthenumberof issuesit found.
To see all the memory-management issues that prevent conversion, select the “Continue building after
errors” option in General preferences, and retry the conversion.
4. Review the recommended changes.
Configure Your Project
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67If the conversion requires changes to source files, Xcode presents the comparison editor to show you the
changes recommended for each of the selected source files. After reviewing the recommended changes,
click Save.
If the conversion does not require changes to source files, Xcode presents a dialog indicating so. Click the
Update button to modify the settings required to build your app using ARC.
For more information on ARC, see Transitioning to ARC Release Notes.
Set the Basic Product Settings
When you create a project, it includes one or more targets, where each target specifies one build product and
the instructions for how the product is to be built. You can use the project editor to specify every aspect of
the build, from the version of the SDK to specific compiler options.
Most developers never need to change the default of the vast majority of the build settings. However, there
are a few basic settings that you must check, and possibly edit, for each target. These settings are gathered
into the Summary pane of the target editor and are somewhat different for Mac OS X and iOS projects.
To edit the basic settings for an app, select the project in the project navigator, and the app target in the
project editor, and click the Summary button.
Configure Your Project
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68Basic Settings for OS X Apps
The Summary pane of the target editor groups the basic settings in three sections: OS X Application Target,
Linked Frameworks and Libraries, and Entitlements.
The OS X Application Target section specifies:
● The app icon, the icon the OS uses to identify the app to the user
● The app category, the main classification for the app
● The bundle identifier, a string that identifies the app to the operating system and the App Store
● The version number under which to publish the app
● The build number, which identifies a particular build of the app
● The deployment target, which is the earliest OS X version on which the app runs
● The main user interface file, which is the user interface file to load when the app launches
● Code signing: Whether to code sign the app when it is built
The Linked Frameworks and Libraries section lists the frameworks and libraries to which to link the app when
built.
TheEntitlementssectionliststheentitlementsthe OSandthe AppStoreusetogrant theappaccesstorestricted
data and special capabilities, such as access to Address Book data and the camera. See App Distribution Guide
for more information.
Configure Your Project
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69Basic Settings for iOS Apps
TheSummarypaneof thetargeteditorgroupsthebasic settingsinfivesections: iOS ApplicationTarget, iPhone
/ iPod Deployment Info, Linked Frameworks and Libraries, Entitlements, and Maps Integration.
The iOS Application Target section specifies:
● The bundle identifier, a string that identifies the app to the operating system and the App Store
● The version number under which to publish the app
● The build number, which identifies a particular build of the app
● The devices for which to build the app (iPhone, iPad, or Universal)
● The deployment target, which is the earliest iOS version on which the app runs
The iPhone / iPod Deployment Info section specifies:
● The main user interface file, the storyboard or nib file to load when the app launches
● User interface orientations, the orientations the app supports (portrait, upside down, landscape left,
landscape right)
● Status bar appearance and behavior, the style, visibility, and color for the status bar
● App icons, the icons the OS uses to identify the app to the user
● Launch images, the screenshots of the app to present when the app launches
The Linked Frameworks and Libraries section lists the frameworks and libraries to which to link the app when
built.
TheEntitlementssectionliststheentitlementsthe OSandthe AppStoreusetogrant theappaccesstorestricted
data and special capabilities, such as access to iCloud data. See App Distribution Guide for more information.
Configure Your Project
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70The MapsIntegrationsectionspecifies whether yourappcanaccept routingrequestsandcanprovidedirections
to other apps on the user’s device. See Location Awareness Programming Guide for more information.
Add Build Configurations
Whenyoucreateaproject,Xcodeprovidestwobuildconfigurations: DebugandRelease, whichdifferprimarily
in the inclusion of debug information and in the degree to which the build is optimized. You might want to
add more build configurations; for example, you might want a build that’s fully optimized but that includes
debug information in order to debug the optimized code.
To add a new build configuration
1. Select the project in the project navigator to open the project editor.
2. Select the project in the project editor and click the Info button.
3. Expand the Configurations section in the Info pane, and click the Add (+) button at the bottom of the
section.
4. Select one of the existing configurations from the pop-up menu as a starting point for the new
configuration.
5. Select the name of the copy and type your preferred name for the configuration.
Configure a uniform set of build setting definitions across any number of targets or projects by using a
configuration file. A configuration file is a plain text file with a list of build setting definitions, one per line. You
can base a build configuration only on a configuration file that is in your project, not on an external file.
To base a build configuration on a configuration file
1. In the project editor, select the project for which you want to use a build configuration file.
2. Click Info at the top of the project editor.
Configure Your Project
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713. In the Configurations section, navigate to the build configuration you want to base on a configuration
file.
4. Choose a configuration file from the pop-up menu in the right column.
See the HTML version of this 
document to view the video. document to view the video.
When you base a target or project’s build configuration on a configuration file, that build configuration
automatically inherits the build setting definitions in that configuration file (and any configuration files it
includes). If you then modify the value of any of those build settings in the target or project, the new value
is used instead of the value in the configuration file.
Build settings defined at the target level override any values assigned to those build settings at the project
level. Therefore, target-level configurations take precedence over any project-level configurations.
The video shows basing the Debug build configuration on a file called Config.xcconfig at the project
level.
Add Build Rules
Xcode processes your source files according to the file type using a set of built-in rules. For example, property
list (plist) files are copied into the product using the CopyPlistFile script located in the Xcode directory.
To see the default build rules for a target
1. Select the project in the project navigator.
2. In the project editor, select the target and click the Build Rules button.
Because Xcode sets build rules on a per-target basis, no build rules are displayed when you select the
project rather than a target.
Configure Your Project
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723. In the filter bar of the Build Rules pane, click the All button.
Inadditiontothedefaultbuildrules, youcanaddcustombuildrulestoyour targetor copydefault targetbuild
rules to your target.
Change the way files are processed with build rules.
To add a build rule
1. In the project editor, select the target to which you want to add a build rule.
2. Click Build Rules at the top of the project editor.
3. Select Target at the top of the Build Rules pane.
4. Click Add Build Rule in the lower-right corner.
5. Choose a file type from the Process pop-up menu.
Configure Your Project
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736. Choose a compiler from the Using pop-up menu.
You can define build rules on a per-target basis. Target-specific build rules can specify files that the system
build rules do not directly address and can override the existing system build rules, which are predefined
and unmodifiable.
The Process and Using menus include many types of files and many compilers, but you can specify custom
file types or compilersby choosing “Source files with names matching:” from the Process menu or “Custom
script:” from the Using menu.
Thescreenshotshowsabuildrulethat compiles C sourcefiles with GCC 4.2rather thanthedefault compiler.
Link Frameworks Conditionally
There may be occasions when you need to configure your app target so that it links to a framework only if
certain conditions are met.
To link a framework only when using a particular SDK, conditionally set the Other Linker Flags build setting to:
-framework 
Use this setting in all configurations for the SDK you want the definition to apply to.
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74If you need to, you can add another condition to the Other Linker Flags build setting to specify a different SDK
and framework.
iOS Configuration
This section describes how to specify product details for iOS products.
Specify the Targeted iOS Devices
The Devicessettingidentifiesthetypeofdevices you want theapptorunon("BasicSettingsfor iOS Apps" (page
70)):
Selection Description
iPhone Includes iPhone and iPod touch devices.
iPad Includes iPad devices.
Universal Includes iPhone, iPod touch, and iPad devices.
For more information on configuring your app for iPhone, iPad, or both device families, see "Advanced App
Tricks".
Specify the Targeted iOS Architecture
An iOS device uses one of a set of architectures, which include armv6 and armv7. The Architectures build
setting identifies the architectures for which your app is built. You have two options for specifying the value of
this setting.
● Standard.Produces anappbinary witha commonarchitecture, compatible withallsupportediOSdevices.
This option generates the smallest app, but it may not be optimized to run at the best possible speed for
all devices.
● Optimized. Produces an app binary optimized for each supported iOS device. However, the build time is
longer than when using the Standard option, and the app is also larger because multiple instruction sets
are bundled into it.
If you need to build your app so that it contains executable code for a different set of architectures than these
predefined values offer, you can choose Other from the Architecture build-setting value list and enter the
custom iOS-device architecture names.
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75Compile Source Code Conditionally for iOS Apps
This section shows how to target code to a simulation or device environment and which frameworks (or
libraries) to link to, depending on whether you’re building your app to simulate its operation or to run it on a
device.
AniOSappcanruninsimulationenvironmentsoroniOSdevices.Yourunyour appinsimulationenvironments
to simulate the app’s execution on your Mac, and you run the app on devices to test its actual performance.
The simulation and device environments are fundamentally different; therefore, when using technology that’s
implemented differently in the two environments, you may need to tweak your code so that some of it runs
in a simulation environment but not on a device.
There may be times when you need to run code in a simulation environment but not on a device, and the
other way around. On those occasions, you can use the preprocessor macros TARGET_OS_IPHONE and
TARGET_IPHONE_SIMULATOR to conditionally compile code for all iOS-based devices.
Listing 3-1 shows how to use the TARGET_IPHONE_SIMULATOR macro to determine whether code meant for
iOS is being compiled for a simulator or a device.
Listing 3-1 Determining whether you’re compiling for a simulation environment or for a device
// Set hello to "Hello, "!
#if TARGET_IPHONE_SIMULATOR
NSString *hello = @"Hello, iOS Simulator!";
#else
NSString *hello = @"Hello, iOS device!";
#endif
Listing 3-2 shows how to use the TARGET_OS_IPHONE macro in a source file to be shared between Mac OS X
and iOS.
Listing 3-2 Using a single source file for iOS and Mac products
#if TARGET_OS_IPHONE
#import 
#else
#import 
#endif
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76The TARGET_OS_IPHONE and TARGET_IPHONE_SIMULATOR macros are defined in the
TargetConditionals.h header file.
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77Interface Builder is an Xcode editor that provides a graphical interface for the creation of user interface files.
Like other Xcode editors, Interface Builder is fully integrated into the IDE, so you can write and edit source
code and tie it directly to your user interface without leaving the Xcode workspace window.
When you create an OS X or iOS app, Xcode includes one or more user interface files in the project. These files,
called nib files, have the filename extension nib or xib. Similarly, when you create a view controller, Xcode
includes a nib file along with the header and implementation files for the new class. For iOS apps, you can use
storyboards instead of nib files, as described in "Design the User Interface of Your iOS App with
Storyboards" (page 91).
Create Your User Interface
Interface Builder, like other Xcode editors, has associated inspectors in the utility area. When you open a user
interface file, your user interface objects appear in the editor area, and the Interface Builder inspectors appear
intheutility area.Youusetheseinspectorstoconfiguretheinterfaceobjects andtomakeconnectionsbetween
them. The Object and Media libraries in the library pane of the utility area are also for use with Interface
Builder—you use these libraries to add new objects to your user interface.
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Edit User InterfacesFigure 4-1 shows a user interface file being edited. You can select objects and media files in the library pane
and drag them onto the Interface Builder canvas. You can also open an assistant editor to view files associated
with the selected in the primary editor.
Figure 4-1 A user interface file in Interface Builder
Display Your User Interface Objects
The dock on the left side of the editor pane shows the user interface objects and placeholders in the user
interface file. The dock can display the high-level objects in an icon view (Figure 4-2) or in a list (called the
outline view) showingall theobjectsnestedinhigher-levelobjects (Figure 4-1). Storyboardfiles show only the
outline view in the dock; however, each scene in the storyboard has its own scene dock displayed below it
when you select the scene.
Figure 4-2 Icon view for placeholders and objects in Interface Builder
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79Add new objects to an Interface Builder document using the outline view, a hierarchical tree that reflects the
parent-child relationships between the objects in the nib file.
To add an object using the outline view
1. With a nib file open, toggle the dock to outline view, if necessary, by clicking the dock mode button
at the bottom of the dock.
2. Navigate to the place in the outline where you want to add the object.
3. Drag an object from the Object library (in the utility area) into the outline.
See the HTML version of this 
document to view the video. document to view the video.
The video shows how to add a text formatter object to a text field cell using the outline view.
Tip: To return to the icon view, click the dock mode button ( ) again.
Note that you can also use the Interface Builder jump bar to select any object in the interface.
Connect to Other Files Using Placeholders
There are two kinds of objects displayed in the Interface Builder dock: interface objects and placeholders.
Interface objects are created when the user interface file is loaded and typically comprise the bulk of the
objects. Placeholders are files that live outside of the user interface file but are intimately tied to the contents
of the nib file. There are normally three placeholders in a nib file:
● File’s Owner
● First Responder
● Application
File’s Owner
File’s Owner represents the user interface file’s controller object. File’s Owner is the most commonly used
placeholder in user interface files. The File’s Owner placeholder is the main bridge between your app and the
contents of the user interface file.
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80You can designate any object in your app as the File’s Owner of an interface file. You tell Interface Builder the
class of the File’s Owner so it knows what connections to make available. Typically, the File’s Owner is an
instance of a controller class that manages the interactions with the views and other controller objects inside
the interface file.
To configure the File’s Owner placeholder
1. Select the File’s Owner placeholder in the Interface Builder dock.
2. Open the Identity inspector.
3. In the Class field of the Custom Class section, set the class of the File’s Owner to the corresponding
class in your app.
Thefollowingtablelistssomeof thestandardclassesthat arecommonlyusedtorepresent File’s Owner
in apps:
Operating Description
system
Subclass of
Document-basedappsstorethedocument window
and other required interface objects in a nib file.
The File’s Owner of this nib file is traditionally the
document object itself.
NSDocument OS X
Window controllers provide a great deal of
automatic management for nib files and are
especially useful when your nib file contains only
one window.
NSWindowController OS X
A view controllersmanagecustomaccessoryviews
and other view-based content.
NSViewController OS X
CustomUIViewControllerobjectsareoftenused
to manage the content view for a distinct screen’s
worth of content. UI view controllers provide
automatic interface-loading and purging support.
UIViewController iOS
You can use practically any object you like for
manual control of an interface file. It is up to you
to define the relationships between this class and
the objects in the interface file.
OS X and
iOS
Any custom NSObject
subclass
4. Control-click the File’s Owner object to see the outlets and actions defined by that object’s class.
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81To learn about outlets and actions, see "Manage Connections Between User Interface Objects" (page 97).
You can use these outlets and actions to connect other objects to File’s Owner. You can use File’s Owner
as a target for your bindings. For information about connecting to File’s Owner, see "Make Connections
Directly Between User Interface Objects and Your Source Files" (page 97).
First Responder
The First Responder placeholder represents the first object in the responder chain, which is determined
dynamically at runtime by the AppKit and UIKit frameworks.
To add new action messages to the First Responder’s supported list
1. Select the First Responder placeholder object in your Interface Builder document.
2. Open the Attributes inspector.
3. Click the Add (+) button at the bottom of the User Defined section to create an action method entry.
4. Double-click the method name in the Action column and type the name of the method.
5. Select the class in which the method will be defined from the pop-up list in the Type column.
6. After youaredonemakingconnectionsinInterfaceBuilder, addthe code for themethodtotheheader
and implementation class files in your project that you specified in step 5.
The name of the method must match the name specified in step 4.
AddingactionmethodtotheFirstResponderplaceholderdoesnotaddthecorrespondingmethoddefinition
to your Xcode source files. All it does is let Xcode know that such a method exists in one of the objects in
the responder chain of your project. It is up to you to ensure the method names you add to the First
Responder placeholder match the names of the methods in your code. Xcode does not validate these
method names for you. At runtime, if a method name is misspelled or does not exist in an object, the
corresponding action message is never received by the target object.
Interface Builder does not prevent you from deleting the standard system messages associated with the
First Responder placeholder. Doing so removes the message name only from the current interface file.
When the operating system sends a message to your app, the message is sent to your app’s first responder.
Thefirst responder istypically thecurrently selectedobjector theobject withthecurrent focusinthefrontmost
window.Youusethefirst responder tomakeconnectionstoanymessagesthatoperateonthecurrentselection
or needtobe handledby your frontmost window ordocument. For example, if you wanteda menu command
to be handled by your frontmost window, you would dispatch that command to your first responder.
The First Responder placeholder displays all the actions that are either supported natively by the operating
system or defined in your Xcode source files.
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82Note: The First Responderplaceholder is only for configuringactionmessages. You cannot connect
the First Responder placeholder to one of your custom outlets in hopes of receiving a dynamically
changing pointer to the selected object in your window. In Mac apps, you should instead use the
firstResponder method of the current NSWindow object to get the first responder. In iOS apps,
there is no single first responder object; the first responder is always the view that is the target of a
touch.
Application
In OS X user interface files, the Application placeholder gives you a way to connect the outlets of your app’s
sharedNSApplicationobject tocustomobjectsintheinterfacefile.Thedefault applicationobjecthasoutlets
for its delegate object and, in Mac apps, the menu bar. If you define a custom subclass of NSApplication,
you can connect to any additional outlets and actions defined in your subclass.
At load time, the interface-loading code automatically replaces the Application placeholder with the shared
application object from your app.
Select Objects in a User Interface File
In Interface Builder, you can usually select an object in an nib or storyboard file by clicking it in the canvas.
Many objects are compound, however, such as a text field that contains a number formatter.
To select an object using the dock
1. Expand the dock to show the outline view.
2. Use the disclosure triangles to open the objects containing the object you want to select.
3. Select the object in the outline view.
Tip: You can make connections directly between the object in the dock and source code or other objects.
To select an object using the jump bar
1. If the top-level window oruser interfaceobject isnot alreadydisplayedonthe InterfaceBuilder canvas,
select the window or object in the dock.
2. Select an object in the jump bar that contains the object you want to select.
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83Tip: You can select the top-level object or any object in the hierarchy that contains the target
object.Youcannotnavigate toahidden UIobject inthe jumpbarby selectingthenibfile itself.
3. Navigate through the jump bar to the object you want to select.
Lay Out User Interface Controls Using Content-Driven Rules
InterfaceBuildersupportsthe AppKit AutoLayout feature. AutoLayout, available starting with OSXv10.7 Lion,
uses relationships called constraints to govern the layout of objects in the user interface. This feature is a
complete replacement for the autoresizing mask. As you make changes to any view or control in Interface
Builder (move it around, resize it, change an attribute, add a subview, and so forth), Interface Builder
automatically adds and removes constraints based on the new layout. When you enable this feature, Interface
Builder shows the constraints as you work, as shown in Figure 4-3.
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84Note: Auto Layout is available only in Mac OS X v10.7 Lion and later. If you are running Xcode 4 in
Mac OS X v10.6 Snow Leopard, Auto Layout is not available.
Figure 4-3 Auto Layout
To use Auto Layout in your project, you turn on the feature on each interface file you want to use it on.
Create user interfaces that adapt dynamically to content and sizing changes by enabling Auto Layout.
To turn on Auto Layout in an interface file
1. Open the user interface document.
2. Choose View > Utilities > Show File Inspector.
3. In the Interface Builder Document section, select Use Auto Layout.
The screenshot shows the Auto Layout option for an OS X user inteface document.
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85Interface Builder treats constraints like other objects in an interface file. As you lay out objects in the canvas,
Interface Builder adds constraints to the object or its containing view. There are three ways to see layout
constraints:
● View the constraints of a container view:
● View the intrinsic constraints of a control.
To see the constraints of a container view or an object in a user interface file
1. Open the user interface file.
2. View the document outline in the Interface Builder dock.
3. Select the view or object for which you want to view constraints.
4. View the constraints in the Constraints list for the container view or control.
Align and Pin Objects in Your User Interface
As you lay out object in your user interface (by aligning them with other objects, or pinning them to the
container view), Interface Builder adds constraints that reflect your layout.
Position objects in relation to other objects or their container.
To align or pin objects in your interface
1. Select the objects.
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862. From the Align o Pin menus in the Editor menu, choose the appropriate command.
If youruser interfacedocumentuses Auto Layout,Xcodeuses constraints to express the objects’ alignment
details.
Important: TheoptionsinthePinmenuintheEditormenuareavailableonlyinuser interfacedocuments
that use Auto Layout.
Any constraint that you have modified or added manually is a custom constraint and is shown on the canvas
with a thicker line than used for the automatic constraints. In the figure, the custom constraint is the one
affecting the width, and the connections to the superview are automatic constraints.
Figure 4-4 Custom constraint
Table 4-1 lists the types of layout constraints.
Table 4-1 Layout constraints
Constraint Figure Notes
Select the object and choose
Editor > Add Constraint >
Width or Editor > Constraint
> Height. Use the Attributes
inspector to specify the value
of theconstraint.Forexample,
“equal to 80 pixels,” or “less
than or equal to 150 pixels.”
The figure shows a constraint
that keeps the width of a
button greater than or equal
to some number.
Size (width or
height)
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87Constraint Figure Notes
Select all the objects that you
want to include and then
chooseeitherEqualWidthsor
Equal Heights from the Editor
> Add Constraint menu. If all
theobjects involvedmaintain
their intrinsic contentsize(see
"Allow Objects to Maintain
Their Intrinsic Content
Size" (page 89)), then the
widthorheightof theobjects
is that of the largest object in
the group. If one of the
objects has an explicit size,
thentheotherobjectsassume
the same explicit size.
Equal size
Select two objects and then
choose either Horizontal
Spacing or Vertical Spacing
from the Editor > Add
Constraint menu. The figure
shows a button and a text
field with a set distance
between them.
Spacing
Select an object an choose
one of the superview
commands from the Editor >
Add Constraintmenu:Leading
Space to Superview, Trailing
Space to Superview, Top
Space to Superview, or
Bottom Space to Superview.
Use the Attributes inspector
to specify the space between
the object and its container.
The figure shows a constraint
holding the leading edge of a
button the standard aqua
space from the leading edge
of the container.
Superview-spacing
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88Constraint Figure Notes
Select all the objects that you
want to include and then
choose an item from the
Editor > Alignment menu.
Alignment constraints are
drawnas a straight line rather
than an I beam. For example,
in the figure, the label and
text field are aligned along
their baselines.
Alignment
You can edit constraints to specify such features as absolute or relative widths or heights.
To edit a constraint
1. Select the constraint (see "To see the constraints of a container view or an object in a user interface
file" (page 86)).
2. Edit the properties of the constraint in the Attributes inspector.
Allow Objects to Maintain Their Intrinsic Content Size
If there are no explicit constraints for width or height, an object assumes its intrinsic content size, which is the
minimum size the object needs to be to hold its contents. For buttons, that might be the title, an image, or
both. For text fields, the contents consist of the string and the bezel, for a combo box, the string in the text
field and the disclosure button, and so forth.
Some objects have an intrinsic content height, but not width. Others, such as buttons, have both an intrinsic
height and width. Some objects, such as table views, have no intrinsic content size. When an object is set to
maintain its intrinsic content size, it resizes as needed to accommodate changes, such as differences in the
length of text strings due to localization.
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89As opposed to an object with an explicit size, an object that maintains its intrinsic content size (and has no
other size restraints) does not have the I-beam size constraint under it, as shown in Figure 4-5. To specify
intrinsic content size, select the object and choose Size to Fit from the Editor menu.
Figure 4-5 Button set to maintain its intrinsic content size
Override Automatic Layout Constraints
Interface Builder helps you to lay out user interface control by adding automatic constraints as you place
objects in a view. For example, if you place a button in the top-left corner of a window following the layout
guides, Interface Builder pins the button to the top-left edges of the window (Figure 4-6).
Figure 4-6 Automatic layout constraints
This means that the button’s left edge is pinned to the window’s left edge. If the user resizes the window by
moving its left edge, the left edge of the button maintains its distance from the left of the window as the user
drags the window’s edge. The button moves with the left edge. However, if the user drags the window’s right
edge, the button does not move.
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90Topin thebutton to the right edge of the view, you wouldselect thebutton andchoose Editor > Pin > Trailing
Space to Superview (this action adds a constraint from the trailing edge of the button to the right edge of the
containing view, shown in Figure 4-7). Now the button is pinned to both left and right edges. Resizing the
window by dragging the left or the right border results in the button changing its size to meet both
horizontal-spacing constraints.
Figure 4-7 Custom layout constraints
Set Priorities to Resolve Potential Conflicts Between Layout Constraints
Occasionally, two constraints can come into conflict when a view is being resized. For example, you might
have set your buttons not to get below a certain size, and also set a minimum width for the view containing
the buttons. You can determine whether the minimum size for the window in this case is determined by the
view width constraint or the button width constraint by specifying a lower priority for one than the other. For
example, if you set the priority for the button width constraint to 50 while the priority for the view width
constraint is1000, AutoLayout will allow theview tobereducedtoitsminimumwidthevenif itmeansreducing
the size of the buttons.
Design the User Interface of Your iOS App with Storyboards
With storyboards you specify your app’s user interface in terms of scenes with transitions between them, and
the controls used to trigger the transitions. Thus you can lay out every possible path through your app
graphically, greatly reducing the amount of code you need to write for a complex multiscreen app.
To create a project that uses storyboards for its user interface files, select the “Use Storyboard” option when
you create the project.
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view controller that configures and implements the subsequent scene.
The arrows between view controllers represent the segues from one scene to another.
To configure a segue
1. Select the segue in the document outline or in the canvas.
2. Configure the segue in the Attributes inspector.
The simplest segue style is Push. The Modal style lets you specify standard transition types, such as flip and
cross-dissolve.Youcanalsochoosethe Customstyletousea customtransition. See"CreatingCustomSegues".
Create User Interface Classes
If you need a custom view object or a view controller, you create the classes in the project navigator. Once
you’vecreatedtheinterfaceandimplementationfiles, youcanconnectuser interfaceobjectsinauser interface
file directly to your code files or you can add connections in the interface files between interface objects and
existing outlets and actions in the user interface file.
When you create an OS X app project or an iOS nonstoryboard-based app project, Xcode includes a nib file
for your main view and a view controller class. When you create an iOS storyboard-based app project, Xcode
includes a storyboard and a view controller class. The view controller is represented in the nib file as the File’s
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92Ownerobject.Whenyouneedanew nibfile for aproject, youshouldcreate the interface andimplementation
files for the controller first. In many cases, Xcode creates a nib file as well. As nib files usually have controllers
already assigned to them, it is rarely necessary to add a separate view controller to a nib file.
Add a New Nib File
When you need a new nib file, first add interface and implementation files for the controller to the project. In
some cases, you automatically get a new nib file as well. If not, you can then add a nib file and link it to the
controller.
To add a new nib file to a project
1. Choose File > New > File and select the template type for your new controller files, and click Next.
2. Specify the name andparent class of the new controller, select the “WithXIB for user interface” option,
and click Next.
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93In the figure, for example, the new class will be a subclass of NSWindowController named
MyWindowController.
3. Specify the location for the new files, and click Create.
Xcode creates a header, implementation, and nib files and adds them to your project.
Tip: Alternatively, you can drag controller and interface files from the File Template library into the project
navigator. When dragging into the project navigator, be sure the group into which you want to drop the file
is highlighted before you drop; you won’t get the results you want if you accidentally drop the file inside
another file.
To see the outlets and actions provided by the parent class of the File’s Owner, click the File’s Owner object
in the dock and open the Connections inspector. To add new actions or outlets to the nib file’s controller, see
"Make Connections Directly Between User Interface Objects and Your Source Files" (page 97).
Add a Custom View
A custom view is a subclass of one of the standard views classes, such as NSView or NSButton. To add a
custom view, first create the view’s class in the project navigator, then add the view to your nib.
To add a custom view to a user interface file:
1. Add the header and implementation files to your project.
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2. Add a custom view to the interface file.
3. Select the customview andspecify its class as the class youaddedinstep1by identifyingit inthe Identity
inspector.
Add a New Controller
Every nib file is created with a File’s Owner object, which you link to the controller for the file. In the rare event
that you need to add another controller to a nib file (to control a subview, for example), you need to create
source files for the controller and add a controller object to the nib file so that you can make connections to
the controller.
To add a controller to a user interface file:
1. Add the header and implementation files to your project.
Select the Objective-C Classtemplate,enteryour customcontroller class’sname,andspecifyNSController
as its superclass.
2. From the Object library, drag an Object object to the Interface Builder dock.
3. Select the customview andspecify its class as the class youaddedinstep1by identifyingit inthe Identity
inspector.
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95To see the outlets and actions provided by the controller, select the controller object in the dock and open
the Connections inspector. To add new actions or outlets to the controller, see "Make Connections Directly
Between User Interface Objects and Your Source Files" (page 97).
Simultaneously Design and Implement User Interface Objects Using
Multiple Editors
When you use custom subclasses in your interface, or add outlets and actions to a controller, you can use an
assistant editor pane to work on your interface code at the same time as your UI design.
To design and implement user interfaces at the same time
1. Select your user interface file in the project navigator so that Interface Builder becomes the primary
editor.
2. Choose View > Assistant Editor > Show Assistant Editor (to open an assistant editor pane).
The assistant editor pane contains a source editor with the implementation file for the controller in
charge of the interface file.
If the assistant editordoesnot automaticallydisplay the file you want,use the jumpbar inthe assistant
editor pane to open the file you want to view.
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The objects in your user interface must communicate with each other and with your source code if your app
is to interact with the user. To specify which messages are sent and received, you use create connections
between objects. There are four fundamental types of connections you can create:
● Outlet connections
● Action connections (Mac OS X only)
● Event connections (iOS only)
● Bindings (Mac OS X only)
Make Connections Directly Between User Interface Objects and Your Source Files
You can make a connection directly from a user interface object to the appropriate header or implementation
file, and, if needed, Xcode inserts code directly into your header and implementation files.
Figure 4-8 shows a connection being made to an existing IBAction statement.
Figure 4-8 Making a connection to source code from a user interface file
Connect an object directly to the declaration of a new outlet in a source file.
To create and connect a new outlet
1. With a nib file open, click the Assistant button.
2. In the jump bar, select the header file in which you want to declare a new outlet.
3. Control-drag from a nib object to the location in the header file for the new outlet.
4. In the dialog, choose Outlet from the Connection menu.
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975. Type the name of the new outlet and click Connect.
See the HTML version of this 
document to view the video. document to view the video.
As you Control-drag from an object to your source code, Interface Builder indicates where a new outlet is
valid. After you enter the name of the outlet, Interface Builder declares the outlet for you and connects the
object to it. You can choose to make the outlet an instance variable or a property.
You may need to add source code that uses the outlet. You can Option-click the name of your controller's
implementation file in the source editor’s jump bar to open the implementation file alongside the header
file.
The video shows connecting an NSMatrix object to a property outlet in a window controller class.
Alternative: Declare the outlet in your source code manually, then connect an object directly
to the outlet declaration.
Connect an object to the declaration of a new action method in a header file.
To create and connect a new action
1. Choose View > Assistant Editor > Open Assistant Editor.
2. In the primary editor, open the user interface document that contains the object that invokes the new
action.
3. In an assistant editor, open the header file to which to add the action-method declaration.
4. Control-drag from the object to the header file.
5. Choose Action from the Connection menu.
6. Enter the name of the action method, and click Connect.
See the HTML version of this 
document to view the video. document to view the video.
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you enter the name of the action, Xcode declares the action for you and connects the object to it.
Xcode also inserts a skeletal definition for the new action in the implementation file. You need to add the
source code that implements the action. You can Option-click the name of the implementation file in the
source editor’s jump bar to open the implementation file alongside the header file.
The video shows connecting a button matrix to a new action in a window controller class.
If you make the connection to a header file, Xcode also inserts code in the corresponding implementation file
as appropriate. For example, if you use Interface Builder to place a new action called loadComposition in a
header file, Xcode inserts the line
- (IBAction)loadComposition:(id)sender;
in the header file and, in the corresponding implementation file, Xcode inserts
- (IBAction)loadComposition:(id)sender {
}
YoucanthenputyourimplementationcodefortheloadCompositionmethoddirectlyintotheimplementation
file.
Note: Because Xcode parses both your header files and implementation files for indexing, you can
define actions andoutlets inimplementation(.m) files withoutneedingtoplace themintheheader
file and you can make connections directly from the user interface file to the implementation file.
Therefore, youdonotneedtoexposepartsof your interfaceor actionstoclients whomightbeusing
your classes.
Note that, because the Control-click key combination is used by Interface Builder to make connections, you
must Control-click on the canvas—not on any object in the user interface—to get the shortcut menu with the
list of help articles for Interface Builder.
Add Outlets and Actions to Classes Programmatically
The easiest way to add an outlet or action to your controller class is by dragging from an user interface object,
as described in "Make Connections Directly Between User Interface Objects and Your Source Files" (page 97).
However, in some cases you might want to define certain outlets or actions in your code before configuring
connections in Interface Builder. To do so, you use the IBOutlet, IBOutletConnection, and IBAction
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99keywords in your code. Because Xcode indexes both header and implementation files, you can add outlets
and actions to the implementation file only so that you do not expose your connections to clients who use
your public header files.
Use the Connections Inspector or the Connections Panel to Make Connections
You can manage outlet, action, and event connections by using the Connections inspector or the connections
panel. These two tools provide the same basic behavior but do so in slightly different ways. The Connections
inspector displays the connections associated with the selected object. Changing the selection changes the
contents of the inspector. The connections panel is an on-demand window that you open by Control-clicking
the object. The connections panel displays the connections for the same object until you dismiss the panel.
You can open multiple connections panels at the same time.
Youcanusethetechniquesdescribedinthissectiontomakeconnectionsthat arealreadydefinedinthesource
code or SDK frameworks. To define new outlets, actions, or events, see "Make Connections Directly Between
User Interface Objects and Your Source Files" (page 97).
To make a quick connection
1. Control-drag from the source object to the target object. If a connection is possible with the target
object, the target object is highlighted.
2. When you complete the drag, Interface Builder displays a prospective list of actions and outlets.
3. Selectanoutlet (of thesourceobject)oranactionorevent (of thetargetobject) tocreatetheconnection.
When you use the Control-drag gesture to create a connection for an action or event, the final part of the
task involves picking the action or event from a list. Outlet connections display a similar list. If there are
previous connections that have the same name, the menu items to pick those names are flagged. If a
connection identical to the one being made already exists, the menu item is flagged with a dot. If a
connection exists with that name, but to a different object, it is flagged with a dash.
Tip: For action connections in Mac apps, this technique is equivalent to opening the connections panel and
configuring the source object’s sent actions connection. Because a source object in OS X can send its action
message to only one target object, you should use this technique only once to configure a given source
object’s actionconnection.Repeatingtheprocessfor the same sourceobjectwouldbreak theoldconnection
beforeestablishingthenewone.Youcanusethistechnique,however, toconfigureeachof thesourceobject’s
outlets.
To make a connection using the Connections inspector
1. Control-click an object and release the mouse button to display the panel.
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1002. Drag from the circle on the right side of the action, outlet, or event you want to connect to the target
object.
If the target of a connection is not visible, placing the pointer over its parent object causes the parent
to open and reveal its children.
If a connection is possible with the target object, the target object is highlighted.
3. If you are usingthe connectionspanel to configure the sent action or referencingoutlet for the object,
when you complete the drag, Interface Builder displays a list of the target object’s action methods or
outlets. Select an action method or outlet from the list to finish the connection.
4. If you want toselectotherobjectsinyour interfacebutdonot want theconnectionspanel todisappear,
drag the panel to a new location.
You do not have to drag the window far; even dragging it a single pixel is sufficient. Note that if you
do this, you must dismiss the window yourself by clicking its close box when you are done.
After you establish a connection, the connections panel fills the circle next to that action or outlet and
displays information about the connection. Each connection also includes a close box icon that you can
use to break the connection. If a received action has multiple source objects associated with it, the panel
displays a disclosure triangle, which you can use to reveal the individual connections. If you select a
connection, Interface Builder displays a path control at the bottom of the panel and a "take me there"
button for the selected connection.
Theconnectionspanel remains visibleaslongas youuseit. If youclickoutsidethepanel (by selectingadifferent
user interfaceobject, for example) InterfaceBuilderdismisses thepanel automatically toget itoutof your way.
You can also dismiss the panel explicitly by clicking its close box.
You can start an action or event connection at the source object to connect from the sent action selector (for
Mac apps)or toconnect fromanevent (for iOSapps).Youcanstart a connectionat thetargetobject toconnect
one of its action methods to a source object.
When connecting from target to source, you can connect each action method multiple times. After you make
the first connection, the circle next to the action method is filled to show that there is an associated source
object. Toconnect anadditional sourceobject,dragfromthe circle tothe targetobject. Performingthis action
does not remove the original connection.
Like action connections, you can create outlet connections starting at either the source or target object. Using
an OS X SDK, only one object at a time may be connected to a given outlet. In iOS SDKs, multiple objects can
be connected to a given outlet.
Youcanalsousethe Connectionsinspector tomakeandview connections.The Connectionsinspectorprovides
a summary of the outlets and actions (or events) of the selected object. You can use the inspector to view the
status of connections, to create new connections, and to remove existing connections.
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101To make a connection using the Connections inspector
1. Open the Connections inspector and select the object from which you want to connect.
2. Drag from the circle next to the entry you want to connect to the target object for the connection. (If
the target of a connection is not visible, placing the pointer over its parent object causes the parent
to open and reveal its children.) If a connection is possible with the target object, the target object is
highlighted when you hold the pointer over it.
3. If you are using the Connections inspector to configure the sent action or referencing outlet for the
object, when you complete the drag, Interface Builder displays a list of the action methods or outlets
of the target object. Select an action method or outlet from the list to finish the connection.
After you establish a connection, the Connections inspector fills the circle next to that entry and displays
information about the connection. Each connection also includes a close box icon that you can use to
remove the connection. If a receivedaction hasmultiple source objects associated with it, the Connections
inspector displays a disclosure triangle, which you can use to reveal the individual connections.
Modify Connections
At times you may need to remove an existing connection and replace it with a new one. You can use either
the Connections inspector or the connections panel to do so.
Change an object’s connections to other objects in a nib file using the connections panel. After making a
connection directly to your source code, you may need to change or remove the connection. The connections
window shows you all the connections to and from an object, and makes it possible to change or remove
them.
To change a connection
1. With a nib file open, Control-click an object to open the connections window.
2. Click the X to the left of the connection name to remove a connection.
3. Drag from the connection well directly to your source code to add a connection.
See the HTML version of this 
document to view the video. document to view the video.
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connections include Cocoa Touch events, actions, outlets, outlet collections, and bindings. If a connection
exists, the circle on the right (called a connection well) is filled in and the name of the connected object is
shown.
For actions, Cocoa Touch events, and referencing outlets, you can create a connection by dragging from
the connections window directly to your source code. If you’re changing a connection, it’s not necessary
to remove the old connection in order to change it.
The video shows changing an action connection.
Alternative: You can also change an object’s connections using the Connections inspector.
Connect Menu Items to Your Code or Your First Responder
There are two common techniques for handling menu commands in a Mac app:
● Connect the corresponding menu item to a first responder method.
● Connect themenuitemtoamethodof your customapplicationobjector your applicationdelegateobject.
Of these two techniques, the first is somewhat more common given that many menu commands act on the
currentdocumentor its contents, whicharepartof theresponder chain.Thesecondtechniqueisusedprimarily
to handle commands that are global to the application, such as displaying preferences or creating a new
document. It is possible for a custom application object or its delegate to dispatch events to documents, but
doing so is generally more cumbersome and prone to errors.
Note: In addition to implementing action methods to respond to your menu commands, also
remember to implement the methods of the NSMenuValidation protocol to enable the menu
items for those commands.
Configure Connections Between Model and View Objects
Cocoa bindings are a controller-layer mechanism used to synchronize the view and model layers of Mac apps.
Bindings establish a mediated connection (through a controller object) between a view and a piece of data,
binding them in such a way that a change in one is reflected in the other.
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configure them. You can configure the bindable properties of an object in the Interface Builder Bindings
inspector. The configured bindings are saved in the nib file and re-created at runtime like other types of
connections.
YouconfigurebindingsinInterfaceBuilderby startingat theobject thatexposesabindableproperty—typically,
a view or controller object. You then use the Bindings inspector to specify the target of the binding and the
binding options. You must configure each binding separately and each binding can be attached to a different
target object. The target of a binding is always one of the recognized controller objects in your nib file, which
typically includestheFile’s Owner, theapplication, theshareduserdefaults controller, andany customcontroller
objects (especially NSController objects) you add to the nib file.
For more information about how Cocoa bindings work, see Cocoa Bindings Programming Topics.
Note: Cocoa bindings are not available in iOS.
Create and Configure a Binding with the Bindings Inspector
In Interface Builder, you typically bind views and controller objects in your nib file to the data in your custom
controller objects.
To create a binding
1. Create the views needed to display your data.
2. Create any intermediate controller objects needed to manage your data. (Typical controller objects
include instancesof your customNSDocumentorNSWindowControllersubclasses,NSController
subclasses, or custom NSObject subclasses that you create to manage your data structures.)
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Although each binding displays several configuration options, the most important part of a binding is the
target of the binding. You must configure, at a minimum, the following fields for any given binding:
● Bind to
● Model Key Path
The Bind to field specifies the controller object to use as the starting point for accessing the target data.
The Model Key Path field contains a string representing the key path for the data. Key path strings are of the
form [.]*. The first property name in this string is a property on the
controller object specified by the Bind to field. Each subsequent property name corresponds to a property of
the object returnedby thepreviousproperty name. Say, for example, that you have a customcontroller object
and the key path string person.address.street. The person property returns the person object of the
bound controller. The address property returns the address of the corresponding person object. And the
street property returns the data value stored in the address object.
Create a Binding by Dragging Directly to Your Header File
As with outlets and actions, you can drag directly from an object in your nib file to code in your header file to
create a binding.
Bind an object directly to a declaration in a header file.
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1. With a nib file open, display the Assistant editor.
2. In the jump bar of the Assistant editor, choose the header file of the object to which you will make the
binding.
3. Control-drag from a nib object to the symbol in the header file for the new binding.
4. In the dialog, configure the binding and click Connect.
See the HTML version of this 
document to view the video. document to view the video.
As you Control-drag from an object to your source code, Interface Builder indicates where a new binding
is valid. After you’ve made the connection, Xcode displays a dialog you use to configure the binding. You
can use the dialog to configure all aspects of the binding.
Interface Builder uses the Xcode index to determine which key paths are valid, and can also discover what
controller it should connect through—you can therefore connect from a user interface element such as a
table column to a property in a model class header.
Note: If the dock on the left of your Interface Builder editor does not look like the one in the
video, click thebutton at thebottom of thedock ( ) to toggle fromoutline view to icon view.
Key Paths Are Dependent on Your Data Model
The best way to understand how to bind key paths in Interface Builder is to go through some examples. The
following sections show how to bind a text field to an NSNumber object to display the number value in that
text field. In each successive example, the data model used to access the number value gets progressively
more complex, and so the bindings must be adjusted in accordance with the increased complexity.
For bindings examples, see Cocoa Bindings Programming Topics.
Bind a Document Object Directly to a Value
The simplest key path occurs when you bind a user interface object directly to a data value in your code.
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1. Set the target object to the document’s File’s Owner.
The document object must be KVC compliant.
2. Set the model key path to the name of the instance variable.
Bind a Document Object to a Data Object Through an Object Controller
Frequently, theFile’s Owner isn't themaindata-containingobject. Instead, youtypicallyhaveotherdataobjects
(often held in a collection), referenced by the File’s Owner. In this case, you should add an object controller
(an NSObjectController object) and bind the user interface object (the view object) to the data object
through the controller object and the File’s Owner. The controller object acts somewhat like a buffer layer
between your view and data object and the controller object acts as a placeholder for the document’s current
Entry object, providing a valid binding target even if the document’s entry property becomes nil.
To bind to a data object through an object controller
1. Set the target object to the NSObjectController object.
The object controller, document object, and data object must all be KVC compliant.
2. Choose either selection or selectedObjects in the Controller Key pop-up menu.
3. Add the target property in the Model Key Path field.
OS X combines the strings in the Controller Key and Model Key Path fields to get the final key path.
Bind to a Collection of Objects Through an Object Controller
Using controller objects,binding to a collection of objects is as simple asbinding to a single object. In fact, the
bindingsthemselves arealmost identical. Insteadofbindingtoa singleobject, youbindtheview toa collection
ofobjectsthroughanNSArrayControllerobject.Thearray controllermanagesboththecollectionofobjects
andthelistof indexes correspondingtotheselectedobjectsandusesthat informationtoprovideanappropriate
value to the text field.
To bind to a collection of objects
1. Bind the text field to an NSArrayController object’s selection property, which represents the
currently selected Entry object.
2. Specify the quantity string for the key path.
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Although the Bindings inspector may seem complex at first, for many bindings, you need to configure only a
few options initially. You may not needto configure every option every time (except for the Bindto and Model
Key Path fields). During your initial design phase, you can probably leave most of the options configured with
their default values. As you improve your design, you can customize the options more until you have the
behavior you want.
For a complete list of bindings available for a given view or controller object, see Cocoa Bindings Reference.
Bind to Objects in a Custom Tree Data Structure
If yourprogramcontainsacustomtreedatastructure, youcanuseanNSTreeControllerobject tocoordinate
bindings to the objects in that data structure. Tree controllers are often used to bind data objects to an
NSBrowser or NSOutlineView object in order to display hierarchical sets of data to the user.
To configure a tree controller object
1. Add the tree controller object to your document and select it.
2. Open the Attributes inspector.
3. Fill in the Object Controller section.
● In the Class Name field, specify the class name of the objects in the tree.
● Optionally, specify any custom keys of the tree objects that you want to expose in the Model Key
Path field of the bindings inspector.
4. Fill in the Tree Controller section.
● Inthe Childrenfield, specify the keypathfor theproperty that identifies the childnodesof agiven
tree object.
● In the Count field, specify the key path for the property that indicates how many children a given
tree object has. (This key path is optional.)
● In the Leaf field, specify the key path for the property that identifies whether the current tree
object is a leaf node. (This key path is optional but recommended because it can improve the tree
controller’s performance as it navigates your tree at runtime.)
For more information on using tree controllers, see Cocoa Bindings Programming Topics.
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108Bind to Your Application Preferences
An NSUserDefaultsController object is most often used when implementing a preferences window or
in any situation where you want to bind a view to values in the defaults database. Although you can add a
new NSUserDefaultsController objects to your nib file, you generally do not need to do so. Interface
Builder provides a shared user defaults controller object that you can use to bind to your application’s
preferences.
To use the shared defaults controller to implement your application’s preferences window
1. Select the control you want to bind to a preference.
2. Open the Bindings inspector.
3. In the appropriate binding for your control, set the Bind to field to Shared User Defaults Controller.
4. In the Model Key Path field, enter the key name of the preference you want to associate with the
control.
Tip: By default, the shared user defaults controller sets the value in the Controller Key field to values.
Because individual preference values are accessed through this property on the user defaults controller, you
should leave this field configured as is.
Formoreinformationonconfiguringuserdefaultsbindings,see"User DefaultsandBindings" inCocoaBindings
Programming Topics.
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109You write and edit code with the Xcode source editor, which has many professional-level features, such as
automatic formatting, code completion and correction, and online documentation. You can discover most of
these features by looking in the Edit and Editor menus as well as Control-clicking in the editor to see the
contextual menu. This chapterbriefly reviews the features you are likely to use most often anddescribes some
features that you might not discover easily by yourself.
Inadditionto writingandeditingcodeinthesourceeditor, youcansetbreakpoints, view thevaluesof variables,
step through running code, and review issues found during builds or code analysis. These features are part of
the debugging and build-run workflows, and so are discussed in other chapters (see "Debug and Tune Your
App" (page 171) and "Configure Your Project" (page 64)).
Customize the Source Editor with Xcode Preferences
Here are some of the ways you can customize both the appearance and function of the source editor in Xcode
preferences by using the Fonts & Colors, Text Editing, and Key Bindings panes.
Modify Syntax-Aware Fonts and Text Colors
Xcodeparses codebasedonthelanguage(asdeterminedfromthefilenameextension) andassigns a syntactic
label to each token or string: comment, keyword, class name defined in the project, other class name, and so
forth. By default, Xcode assigns a color and font to each syntactic type to make it easier for you to read the
code.Xcode Fonts & Colorspreferences allows youtoselect amongseveral font andcolor themes; for example,
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Edit Source Codethe Presentation theme increases the font sizes so that the text is easier to read when projected on a screen.
You can also create your own custom font and color theme. For example, in Figure 5-1, symbols defined in the
project are given a distinct color to make them easier to pick out.
Figure 5-1 Fonts & Colors preferences
Customize the appearance of source code and console text by changing their colors and fonts in Fonts &
Colors preferences. For example, you could display your code comments in purple in the source editor. For
the console, you could set your debugger input and your debugger output to a 14-point font.
To set font and color preferences
1. Choose Xcode > Preferences and click Fonts & Colors.
2. Click either Source Editor or Console near the top of the preferences window.
3. Select a theme.
4. Select a syntax category.
5. To change the font, click the Fonts window button, and make your selections in the Fonts window.
6. To change the text color, click the font color well, and choose a new color in the Colors window.
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1117. To change the color of other items in the source editor or console, click a color well at the bottom of
the pane, and choose a new color.
Thesourceeditor’s Comments category for the Default themeisselectedinthescreenshot. A themeincludes
preset colors andfontsfor all thesyntax categories.Xcodeincludes a setofstandardthemes,suchas Default,
that you can modify or delete. You can restore any of the standard themes by selecting from a set of
templates that are displayed when you click the Add (+) button at the bottom of the theme list.
For the source editor and the console, you can also customize colors for the:
● Background
● Selection
● Cursor
● Instruction pointer (for the console)
Tip: Youcanchangethefontor fontsizefor all thesyntax categoriesina theme.Select a category,
press Command-A to select all categories, and modify the settings for the font or font size.
Customize the keyboard shortcut for a command by editing its key sequence in the Key Bindings preferences
pane.
To customize keyboard shortcuts
1. In the Key Bindings preferences pane, choose a command set to edit.
2. Locate the command for which you want to change the shortcut.
3. Double-click a key sequence to select it.
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5. Click elsewhere in the detail area to apply your change.
See the HTML version of this 
document to view the video. document to view the video.
To edit the key binding for a command, double-click its key field, and then:
● To change a selected sequence, type a new one to replace it.
● To remove a selected sequence, click the Remove (—) button. (Do not press the keyboard Delete key;
that just adds Delete to the key sequence.)
● To enter a sequence in an empty key field, type the sequence.
● To add a sequence to an existing one, click the Add (+) button and type the new sequence. This only
works for text commands; you cannot assign more than one sequence to a menu command.
Important: Whenyouhavemadeyour changes,besuretoclickoutsidethekey fieldtocloseit.Pressing
any key while the field is open changes the key sequence.
Specify a key sequenceby typingit just as you wouldtype it touse it; for example, tospecify ^A,holddown
the Control key and type the letter a.
A specific key sequence can be bound to only one command; if you enter one that is already assigned to
another command, Xcode removes it from that other command.
Thevideoshowsaddingthekeysequence Control-Option–Right Arrow asashortcut for the MoveExpression
Right command.
For detailed information about key bindings, see “Text System Defaults and Key Bindings” in Cocoa
Event-Handling Guide.
Set Your Text-Editing and Automatic Indentation Preferences
You can set several preferences that control the appearance and behavior of the source editor—including
whether line numbers are displayed, how delimiter balancing and the code focus ribbon work, and some
aspects of code completion—in the Editing pane of Text Editing preferences.. You can control many of the
automatic-indenting features of the editor in the Indentation pane of Text Editing preferences. Control-click
in either pane to see a help article that describes the use of the fields.
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113Enter Code Quickly and Accurately with the Help of the Source Editor
The source editor includes several features that help you enter code and avoid mistakes:
● Code completion
● Quick Help
● Automatic delimiter balancing
● Automatic indenting
● Syntax formatting
● Fix-it
Speed Up Typing with Code Completion
When you begin typing the name of a symbol that Xcode has indexed, it offers an inline suggestion for
completing the symbol name plus a list of possibilities (Figure 5-2). Click an item in the suggestion list or use
the Up Arrow and Down Arrow keys to select one. As you do so, the inline suggestion changes as well.
Furthermore, as you can see in the figure, if you open the Symbol inspector in the utility pane, you can read
documentation about each selection. You can turn off automatic code completion in the Text Editing pane of
Xcode preferences, but you can always invoke code completion by pressing Control–Space bar or Esc.
Figure 5-2 Code completion
Finish entering a symbol by accepting an Xcode suggestion for completion. The proposed symbol is based on
the text you have typed so far and the surrounding context. Continue typing to refine the list of choices.
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114To enter text with code completion
1. Begin typing the name of a symbol.
2. Click an item in the suggestion list.
3. Press Return to accept the suggestion.
See the HTML version of this 
document to view the video. document to view the video.
If all of the possible completions have a common prefix, the prefix is indicated with a dotted underline.
Press the Tab key to accept only the prefix, or press Return to accept the entire suggestion.
Press Control–Space bar to toggle the completion suggestion on or off. That is, if the inline suggestion and
list are being displayed, pressing Control–Space bar cancels the code completion operation. (Pressing the
Esc key or clicking elsewhere in the text also cancels the operation.) If there is no suggestion displayed,
placetheinsertionpointat theendofapartially-typedsymbolandpress Control–Spacebar toget completion
suggestions.
To turn off the code completion feature, choose Xcode > Preferences and click Text Editing. In the Editing
pane, deselect the option “Suggest completions while typing.” You can always invoke code completion by
pressing Control–Space bar.
A Quick Helppop-up window isavailablefromcodecompletion. Holdthepointerover thecodecompletion
option you’re interested in until a question mark icon appears. Click the question mark to open Quick Help.
As before, press the Tab key to accept the prefix or Return to accept the entire suggestion. Click the Done
button in the Quick Help window to close the window.
When a method or function contains parameters or arguments, code completion includes a placeholder
foreach. ChoosetheJumpto NextPlaceholder (Control-/)andJumptoPreviousPlaceholder (Control-Shift-?)
items in the Navigate menu to move from one placeholder to another.
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115Note: The code completion feature is not fully functional until Xcode finishes indexing your
project.
Code completion inline quick help is shown in Figure 5-3. Code completion placeholders for parameters are
shown in Figure 5-4.
Figure 5-3 Quick Help for code completion
Figure 5-4 Placeholders in code completion text
Balances Delimiters Automatically
When you create a new file or edit an existing one, Xcode determines the source language from the filename
extension and attempts to determine the syntax of the text based on the source type. For example, a file with
a .h or .m extension is assumed to be a variety of C and formatted accordingly. In that case, the editor indents
the text according to the rules you set in Text Editing preferences and uses fonts and colors for the various
syntax elements (variables, constants, comments, and so forth) according to the settings in the Fonts & Colors
pane of Xcode preferences.
When you’re writing code, type an opening brace ({), and continue typing, Xcode automatically adds a closing
brace (}) unless you’ve deactivated this feature in Text Editing preferences. There are several other features
that help you to balance delimiters, including double-clicking a delimiter to select the entire expression.
To get assistance in balancing delimiters
Do one of the following:
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Xcodeautomatically inserts a closingbraceafter youenter a linebreak. (If youdon’t want closingbraces
automatically inserted, choose Xcode > Preferences, click Text Editing, and deselect “Automatically
insert closing ‘}’”.)
● Use the Right Arrow key to move the insertion point past a closing delimiter.
Xcode briefly highlights its counterpart.
● Double-click any delimiter.
Xcode selects everything up to and including the matching delimiter.
● Position the pointer over the focus ribbon.
Xcode highlights the scope at that location.
● Type a closing brace or other delimiter.
Xcode causes its counterpart to blink.
● Choose Editor > Structure > Balance Delimiter.
Xcode selects the text surrounding the insertion point, up to the nearest set of enclosing delimiters.
Have Fix-it Flag Errors as You Type
When your target is set to use the LLVM compiler, a feature called Fix-it scans your source text as you type.
Correct mistakes with Fix-it as you enter source code.
To catch mistakes with Fix-it
1. In a target built with the LLVM compiler, open a source file.
2. Introduce an error in the code.
3. When a red underbar or a caret appears, click the symbol in the gutter to see the error message.
4. If Fix-it suggests corrections, select a correction and press Return.
See the HTML version of this 
document to view the video. document to view the video.
Edit Source Code
Enter CodeQuickly and Accurately with theHelp ofthe Source Editor
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
117Fix-it scans your source text as you type. Fix-it marks syntax errors with a red underbar or a caret at the
position of the error, and a symbol in the gutter. Clicking the symbol displays a message describing the
possible syntax error and, in many cases, offers to repair it automatically. Select a suggested correction and
press Return to accept it. Press Esc to cancel the operation.
To use Fix-it, you must build the target with the LLVM compiler and the indexing of your project must be
complete. Fix-it works with the C, Objective-C, and Objective-C++ languages.
The video shows correcting a double equals sign in an assignment statement.
Tip: If there are several Fix-it warnings ina file, you cannavigate to thenext orprevious warning
by choosing Navigate > Jump to Next Issue or Navigate > Jump to Previous Issue.
Find and Display Related Content
Xcode provides several features that help you find content related to the code you’re currently editing: you
can open a file based on a partial string, you can jump to a symbol definition, you can navigate to related
content using a button in the jump bar in the primary editor or in a split editor, or you can split the editor and
have Assistant find related content for you.
Open a FIle Quickly
Sometimes you may need to open a file whose location you don’t know, or you may want to open the file that
defines a particular symbol, such as a variable, method, or class. The Open Quickly command finds files that
define a specified symbol or whose filename contains a specified string. Open Quickly searches are case
insensitive and limited to the current project and the active SDK.
To use the Open Quickly command
1. Choose Open Quickly from the File menu.
2. In the search field, type any portion of the name of the file you want to open or the symbol you want
to find.
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118Tip: Select a filename or symbol name in the editor and invoke the Open Quickly command
to prefill the dialog’s search field with the selected text. Or, to open a header file referenced in
a #include or #import statement, place the cursor on the line of the statement and invoke the
Open Quickly command to search for the header file.
3. From the search results list, double-click the file you want to open, or select the file you want to open
and click Open.
Tip: To open the file in the assistant editor, hold down the Option key when you double-click
or click Open. To open the file in a separate window, hold Option-Shift. To see a dialog letting
you specify where the file should open, hold down Option-Shift-Click. You can change these
behaviors in the General preferences pane.
Infilename-basedsearches,Xcode searches forheader files, implementationfiles,model files,nibfiles,plist
files, and project packages. In symbol-name–based searches, it searches source code files only.
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119Split the Editor Area to Display Related Content
Xcode allows you to split the editor pane to provide multiple views of the same file or to view multiple files at
once.
To split the editor, open an assistant editor pane by choosing View > Editor > Assistant or by clicking the
Assistant button in the workspace toolbar (Figure 5-5).
Figure 5-5 The Assistant button
To see the same file in each pane
1. Open an assistant editor pane.
2. Select Manual from the Assistant pop-up menu ("To set the behavior of the assistant editor" (page
126)).
Edit Source Code
Find andDisplay Related Content
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
120You can view any portion of the file in either split plane, and you can edit the file in either pane. Any
changes made in one pane are instantly reflected in the other.
The split can be horizontal (as shown in the figure) or vertical. To change the orientation of the split,
choose View > Assistant Layout.
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121Customize Keyboard Shortcutsto Determine Where a File’s Contents Are Displayed
Selectinga fileintheprojectnavigatoror jumpbar causesthat filetoopeninthenormaleditorpane. If Assistant
is set to tracking mode, it tracks the change. By default, if you hold down the Option key when selecting a file
in the project navigator or jump bar, Xcode displays that file in the Assistant pane rather than the standard
pane. Doing so switches Assistant to manual mode.
You can customize the behavior of the single click, Option-click, and double-click keyboard shortcuts in the
General pane of Xcode preferences (Figure 5-6).
Figure 5-6 General preferences
To customize the behavior of keyboard shortcuts for opening a file, open General Preferences and choose an
option from each navigation pop-up menu. The options include:
● Primary editor: Opens the file in the primary editor pane in the window and tab already open.
● Focused editor: Opens the file in whichever editor pane currently has focus.
● Single assistant editor: When the navigation originates in a navigator pane or the primary editor (using
the jump bar or the jump to definition command), if the assistant editor is not open or is not split, opens
the file in the assistant editor.
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122If the assistant editor is split, displays a navigation chooser dialog (Figure 5-7) showing the current layout
of editorpanes in the window that has focus, with the option of selecting any open editorpane or adding
a new one. Double-click your selected pane, or make your selection and press Return. Press Esc to cancel.
Figure 5-7 The Single Assistant navigation chooser dialog
If the file is already open in one of the editor panes, the navigation chooser displays a star to indicate the
pane containing the file.
When the navigation originates in an assistant editor pane, Xcode opens the file in the primary editor.
● Separate assistant editor: If the assistant editor is closed and is not split, opens the file in the assistant
editor.
If the assistant editor is open, opens the file in a new assistant editor pane.
If the assistant editor is split but closed, opens the file in the most-recently-opened assistant editor pane,
replacing the file that was in that pane.
If the file is already open in an assistant editor pane, switches the focus to that pane.
● Separate tab: If the file is not already open in the current window, opens the file in a new tab.
If the file is already open in another tab in the same window, switches the focus to that tab.
● Separate window: If the file is not already open in a separate window, opens the file in a new window.
If the file is already open in a separate window, switches the focus to that window.
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123The Option-Shift-Click key combinationopens anavigationchooserdialog(Figure5-8 (page124))showingthe
current layout with the options of selectingany open editorpane in any window andany tab, or addinga new
editor pane, window, or tab. Double-click your selection, or make your selection and press Return. Press Esc
to cancel.
Figure 5-8 The navigation chooser dialog
Jump to a Symbol’s Definition
You can jump to the definition of a symbol and display it in the primary editor window, in a split editor pane,
in another tab, or in another window.
To jump to a symbol’s definition
1. Hold down the Command key., and command-click the symbol in which you’re interested.
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1242. Move the pointer over text to highlight each symbol that can be used as a link to a definition.
3. If there is more than one definition for the symbol, Xcode displays a list of possibilities. Click the one
you want.
Alternatively, select the symbol in which you’re interested and choose Navigate > Jump to Definition or
Control-click the symbol and choose Jump to Definition from the shortcut menu.
Tip: Use one of the modifier keys set in the General pane of Xcode preferences together with any of the
methods described here to open the definition in a split editor pane, a tab, or another window.
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125Find Related Items with the Jump Bar
Use the related items pop-up menu in the jump bar (Figure 1-9 (page 25)) to jump to files and classes related
to the file you have open. For example, you can find superclasses and subclasses of the class defined in the
open file, headers included in the file, or headers that include the file. For a header file you can jump to the
implementation file, and vice versa.
Find Related Content Automatically
When you open an assistant editor pane, you can set Assistant to either of two modes: tracking (or automatic)
mode or manual mode. Tracking mode has several criteria from which you can choose, such as counterparts,
superclasses, subclasses, or siblings. Assistant selects the file or files that best meet the selected criterion and
opens those files in the assistant editor pane. In manual mode, you select the file to display by navigating to
it in the jump bar. You can split the assistant editor into as many panes as you wish.
To set the behavior of the assistant editor
1. Open an assistant editor pane.
2. Open the Assistant pop-up menu. The Assistant pop-up menu is the first item to the right of the back
and forward arrows in the assistant editor jump bar.
3. Make a selection from the menu.
Tip: The choicesofferedinthe Assistantpop-upmenudependonthe typeof filebeingedited.
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126To split the assistant editor
1. Click the plus sign at the right end of the assistant editor jump bar to split the editor.
2. Set each Assistant pane to manual or tracking.
3. Set each tracking pane to a tracking criterion.
The figure shows one file on the left of the split editor pane, the counterpart file in the upper-right
Assistant pane, and another view of the file in the lower-right Assistant pane.
Tip: To change the orientation of the split editor panes, choose View > Assistant Layout.
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127Use Assistant with Interface Builder and Data Models
When you’re using Interface Builder to design a user interface, you can use Assistant to automatically display
the code file most relevant to the interface element you’re working with. See "Simultaneously Design and
Implement User Interface Objects Using Multiple Editors" (page 106) for details. Similarly, when you use the
Core Data modeling editor, the assistant editor can display model classes related to the entities in your model
(Figure 5-9). The Core Data modeling editor is discussed in "Edit Data Model Documents" (page 41).
Figure 5-9 The assistant editor used with a data model
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128Incorporate Other Source Editor Features into Your Workflow
The source editor provides many features to make it easier to write and maintain your code. This section
highlights a few of these features not described elsewhere in this document.
Examine the Structure of Your Code with Code Folding
One powerful way to examine the structure of source code is to use the focus ribbon, also called the code
folding ribbon.
Focus your attention on aparticular methodor function in source codeby hidingthe otherparts of the source
code.
To fold and unfold source code
1. With a source file open, click anywhere in the source code.
2. Choose Editor > Code Folding > Fold Methods & Functions.
3. Navigate to the method you want to unfold.
4. Double-click the ellipsis button to unfold the method.
5. Use the focus ribbon to select the method’s scope.
6. Click in the focus ribbon to fold the method.
See the HTML version of this 
document to view the video. document to view the video.
The Code Folding submenu provides several options for folding and unfolding code.
The focus ribbonis locatedbetweenthe editorgutter andthe source code. Move thepointer intothe focus
ribbon to display a scope in the focus box. Then click in the focus ribbon to fold the code in scope.
The video shows the steps for folding all the methods and functions in the source code, unfolding the
method naturalSize, and folding the same method using the focus ribbon.
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129If you have the option “Focus code blocks on hover” selected in Text Editing preferences, then you can move
the pointer over the focus ribbon to examine the various scopes of code blocks in a file. In Figure 5-10, for
example, the pointer is over the focus ribbon next to an if statement and three scopes are indicated by
degrees of shading in the code: the if statement, the method (showOrHideWindow) containing the if
statement,andtheclassimplementation(NSWindowController(SKTConvenience))containingthemethod.
Figure 5-10 The focus ribbon in use
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130View Preprocessor or Assembly Output
You can use commands in the Product > Generate Output menu to process source files and generate the
preprocessed output (Figure 5-11) or assembly output.
Figure 5-11 Preprocessor output
The preprocessor evaluates directives in your source code (instructions starting with the pound sign (#) such
as includes, defines, and conditional logic) and converts them into C code to be sent to the compiler. You can
examine the preprocessed output to make sure that the logic in your source code is being interpreted by the
preprocessor as you expect in order to debug compilation problems.
The assembly output is the set of instructions that the compiler generated from the preprocessed output. You
can study the assembly output to see how the instructions were formed or ordered, to seek out better
optimization patterns, or to look for compiler bugs.
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131The output type is also a new category in the assistant editor for a selected primary file (Figure 5-12).
Figure 5-12 Generated output in Assistant jump bar
View Documentation for a Symbol Using Quick Help
You use Quick Help in the Symbol inspector to get information about API symbols, user interface objects, and
build settings.
Find concise reference documentation for an API symbol without moving away from your source file.
To look up documentation for an API symbol
1. With a source file open, click the Symbol inspector button in the utility area.
2. Place the insertion point in an API symbol in the source editor.
3. View the documentation under Quick Help in the Symbol inspector.
4. To view more detailed information, click the API name at the top of Quick Help.
See the HTML version of this 
document to view the video. document to view the video.
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132When you place the insertion point in a symbol, summary reference information appears in the Symbol
inspector in the utility area.
The information includes links to:
● Complete reference documentation for the symbol
● The header file where the symbol is declared
● Related programming guides
● Related sample code
Alternative: To view concise reference information for an API symbol in a pop-up window,
Option-click the symbol in the source code.
To get information about a symbol when the utility area is closed, you can open a Quick Help window by
Option-clicking the symbol (“Find and Display Related Content”).
Figure 5-13 The Quick Help window
Findconcisedocumentationforanobjectusing Quick Help.Youcanfindconciseclassreferencedocumentation
for a single object without taking your focus away from your nib file.
To look up documentation for an Interface Builder object
1. With a nib file open, click the Quick Help button.
2. Click the object about which you want information.
3. View the documentation under Quick Help.
Edit Source Code
IncorporateOther Source Editor Features into Your Workflow
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
1334. To view more detailed information, click the title of the reference document.
See the HTML version of this 
document to view the video. document to view the video.
Quick Help offers a persistent location for API reference documentation. When you click an object, Quick
Help displays information about that object.
For complete reference information about the object, click the title of the reference document listed in
Quick Help. The reference document opens in the Organizer window. You can also open relevant
programming guides, sample code, and other related documents by clicking their titles in Quick Help.
Find concise documentation for a build setting using Quick Help.
To look up documentation for a build setting
1. Click Build Settings at the top of the project editor.
2. Display the Symbols inspector.
3. Select a build setting.
4. View the documentation under Quick Help in the Symbols inspector.
See the HTML version of this 
document to view the video. document to view the video.
Quick Help provides a persistent location for build setting documentation without taking your focus away
from the build settings pane. Whenever you select a build setting, Quick Help displays information about
that item.
The video shows viewing information on a build setting in Sketch.
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134Alternative: Option—double-click a build setting to open Quick Help in a separate window.
Unlike Quick Help in the utility area, the Quick Help window is not persistent.
Automate Extensive Changes in Your Files
Inadditiontoall thefeaturesXcodeprovidestomakeiteasier toenter andcorrect your code, therearefeatures
at several scales to help you make changes that apply to more than one line of text. These include Edit All in
Scope, Search and Replace, and Refactor.
Simultaneously modify all the occurrences of a symbol within a scope with the Edit All in Scope feature. For
example, you can change the name of a local variable or parameter everywhere in a scope at the same time.
To edit a symbol everywhere in a scope
1. Place the insertion point in the symbol you want to edit.
2. When the pop-up menu appears, select Edit All in Scope.
3. Edit the symbol.
See the HTML version of this 
document to view the video. document to view the video.
Placing the insertion point in a symbol underlines all occurrences of that symbol in the scope and lets you
see the extent to which it is used.
Choosing Edit All in Scope from the pop-up menu selects all occurrences of the symbol. As you type new
text, all selections of the symbol change simultaneously.
ThevideodemonstrateschangingthesymbollowerRighttolowerRightCorner withinthealignedRect
method.
To find and change all the instances of a text string in a single file, choose Edit > Find > Find and Replace.
To find and change all the instances of a text string in your project or workspace, use the Replace option of
the search navigator (see "Replace Text Strings" (page 209)).
Torefactor code(that is, tochangethecode without changingitsbehavior),see"ImproveYour Code’sStructure
Through Refactoring" (page 215).
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135Incorporate Files and Code from the Xcode Libraries
Xcode provides libraries of file templates and code snippets that you can use in your program. It also has
libraries of Interface Builder objects and media files that you can use in your nib files. The library pane is in the
lower part of the utility area (see “The Xcode 4 workspace window” (page 12)). Each of the buttons at the top
of this pane selects a category of library objects, as follows:
● File templates range from templates for applications to subclasses of commonly used Cocoa classes. File
templates have subcategories, which you can choose from the pop-up menu below the line of buttons.
You can display the templates as icons only or as icons and text. Drag file and project templates to the
project navigator.
● Code snippets are short pieces of source code that you can use in your software. To use one, drag it
directly into your source code file. Alternatively, you can select a portion of the code from the code
information pop-up window and drag that into your file. When you create a code snippet, you can add a
completion shortcut, which you can use when editing source code. Type the shortcut and select the
completionshortcut fromthe completionlist to addthe code snippet to your file. Note that thenew code
snippet is flagged with the word “User”.
● Interface builder objects are organized with subcategories and provide information pop-up windows
like those for the file templates andcode snippets. Dependingontheobject, youdragitontothe Interface
Builder canvas, into another object on the canvas, or into the Interface Builder dock. See "Edit User
Interfaces" (page 78) for more information on Interface Builder.
● Media files include all the graphics, icons, sound files, and other media files that you use in your code.
When you’re editing an Interface Builder document, the Media library also shows the built-in template
images from NSImage and sounds provided by the system. In Interface Builder, you can drag an image
from the library and drop it into your user interface. Interface Builder creates an image view to hold the
dropped image. Alternatively, you can drag an image into an existing button, image view, or any other
object that can contain an image. You can set a sound on an NSButton object.
Add a new file to a project or workspace using the File Template library. This library offers a convenient way
to create files in your project or workspace.
To add a new file from the File Template library
1. Choose File Template Library from the Utilities menu under the View menu.
2. Select the file template in the library.
3. Drag the template to a project or group in the project navigator.
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1364. Name the file, and click Save.
See the HTML version of this 
document to view the video. document to view the video.
The videoillustratesusinga template fromthe File Template library toaddan Objective-C classtoaproject.
Note that the library button is labeled with a file icon.
Using the provided file templates ensures that certain minimal file characteristics are correct for a file. For
example, asseeninthevideo,Xcodeautomatically createsboththeimplementation(.m) fileandtheheader
(.h) file for the new Objective-C class.
When you click a template, an information window pops open with information about the use of the template
(Figure 5-14).
Figure 5-14 A file template information pop-up window
Add frequently-used source code to your project by using a snippet from the Code Snippet library.
To drag a code snippet to a source file
1. With a source file open, click the Code Snippet library button.
2. Select a code snippet.
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1373. Drag the snippet to the source file.
See the HTML version of this 
document to view the video. document to view the video.
The system-supplied snippets in the library are designed to speed development and help ensure code
integrity. You can also create custom code snippets.
The videoillustratesusinga code snippet toaddaninitmethodtothe implementationof an Objective-C
class.
Extend the scope of the Code Snippet library by creating custom snippets. The Code Snippet library provides
a number of useful standard snippets. You can add to this collection by creating your own custom snippets.
To create a custom code snippet
1. Open the Code Snippet library.
2. Select some text in a source file and drag it to the library.
3. Open the new custom snippet and click Edit.
4. Give the snippet a name and click Done.
See the HTML version of this 
document to view the video. document to view the video.
Code snippets let you enter source text with minimum effort. You can drag a standard or custom code
snippet into a source file. You can also type a completion shortcut to enter a snippet.
Tip: Youcaninclude tokensina customsnippet. For example, the stringadds a token
labeled Code in the source text created by the snippet.
Enter source code text with minimum effort by typing a completion shortcut for a code snippet.
Edit Source Code
IncorporateOther Source Editor Features into Your Workflow
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
138To determine the shortcut for a code snippet
1. In the Code Snippet library, select the snippet for which you want to use a shortcut.
2. Click Edit.
3. In the Completion Shortcut field, note the shortcut or add one.
4. Click Done.
Code snippets let you quickly enter source code. You can drag a snippet from the Code Snippet library into
a source file. Or, for maximum efficiency, type a snippet shortcut in the text of your source code, then press
Esc and then Return to enter the snippet. In most cases, when you begin typing the snippet’s completion
shortcut,Xcode suggests it, so you need only accept itbypressing Return. Both standard and custom code
snippets support completion shortcuts. You can edit the shortcut for a custom snippet.
The screenshot shows a completion shortcut highlighted.
Filter the library items displayed in the selected library by entering text into the search field at the bottom of
the library pane.
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139Use Inspectors to View and Enter Data
Inspectors are panes in the utility area that you can use to read or enter data about files, Interface Builder
objects, symbols, and data models. Figure 5-15 shows the File inspector.
Figure 5-15 The File inspector
The Symbol inspector isdiscussedin"View Documentationfor a Symbol Using Quick Help" (page132). The File
inspector and Symbol inspector are always available. Other inspectors appear when appropriate. For more
information about Interface Builder, see "Edit User Interfaces" (page 78).
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140To build and run your app, Xcode uses the settings in your project and information in a build plan known as
a scheme.
Create, Edit, and Manage Schemes
InXcode,beforeyoubuild, youselectascheme, whichspecifies whichtargetstobuild, whatbuildconfiguration
to use, and the executable environment to use when the product specified by the target is launched. You also
select a run destination. When you create a new Mac OS X project, Xcode provides a default scheme and two
run destinations: local 32-bit and local 64-bit. For an iOS application, the run destinations are devices and
simulators.
You can add as many additional schemes as you want. For example, you might want one scheme that builds
both your application and a plug-in before running, and another that builds the product without the plug-in.
Or if you have two different but commonly used Instruments templates, you might have one scheme for
profiling with one of the templates and a different scheme for the other one.
You use the Scheme pop-up menu in the upper-left corner of the workspace window (Figure 6-1) to select a
scheme and run destination. Choose the scheme you want to edit and then choose Edit Active Scheme from
that menu to edit an existing scheme. Choose Manage Schemes to change the list of schemes, where they’re
stored, and whether they’re shared. Choose New Scheme to add a scheme to your project. Alternatively, you
can choose Edit Scheme, New Scheme, or Manage Schemes from the Product menu.
Figure 6-1 The Scheme pop-up menu
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Build and Run Your AppThe left column of the scheme editing dialog (referred to hereafter for brevity’s sake as the scheme editor) has
a list of actions you can perform, plus the Build item, which you use to determine which targets are built for
eachtypeof action. Eachactioncanbe set toproduce either adebugor releasebuild(or, if you’ve addedmore
build configurations, those are listed as well). There are options for building, running, testing, profiling (using
Instruments), analyzing, and archiving your products.
You can execute scripts andhaveXcode sendemailsbefore or after abuildor any of the actions in the scheme
editor.
To set up pre- or post-actions
1. In the scheme editor, open the disclosure triangle next to Build or any of the actions in the left pane.
2. Click the Add button at the bottom of the right pane and choose New Run Script Action or New Send
Email Action.
3. In the template that opens, fill in the fields.
The figure shows two pre-run actions: an email that’s sent and a script that’s executed before the
product is launched.
Build and Run YourApp
Create, Edit, and Manage Schemes
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
1424. For a Run Script pre-or post-action, if your script needs to access values from target build settings,
choose the target from the “Provide build settings from” pop-up menu.
Specify Which Targets Are Built for Each Type of Action
By default, Xcode creates one scheme per target in your project or workspace, and the Targets column shows
the target for which the scheme was created. However, you can add as many targets from your project or
workspace to a single scheme as you wish.
Edit a scheme to determine which targets are built when you choose Run, Test, Profile, Analyze, or Archive
from the Product menu.
To build multiple targets
1. From the Scheme toolbar menu, choose a scheme.
2. From the same menu, choose Edit Active Scheme to display the scheme dialog.
3. In the left column, select Build.
4. For each target, select the actions for which to build the target.
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1435. Click OK.
Targets which are required due to their use in the Run, Test, or Profile actions cannot be turned off.
SelectParallelizeBuildif you want tobuildall independent targets at thesametime. If youselect thisoption,
the build is faster but it may not produce correct results unless you set up target dependencies correctly.
The Find Implicit Dependencies option is selected by default. Deselect this option if you add a project to
your workspace that you don’t want used automatically.
Rename or Reorganize Your Schemes
By choosing Manage Schemes from the Product menu (or from the Scheme pop-up menu) you can see a list
of all the schemes in the project. You can rename or reorganize the schemes in the menu. You can also specify
whether each scheme should be displayed in the pop-up menu, where the scheme is stored (in the project or
workspace) and whether the scheme should be shared with others using the project or workspace.
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144The Manage Schemes dialog has four settings for each scheme plus several other controls, as shown in “The
manage schemes dialog.”
Figure 6-2 The manage schemes dialog
The four columns in the Manage Schemes dialog are used as follows:
Show Displays or hides the scheme in the Scheme menu.
Scheme Specifies the name of the scheme. You can edit this name.
Specifies whether a scheme should be stored in a project—in which case it’s available in
every workspace that includes that project—or in the workspace—in which case it’s
available only in that workspace.
Container
Specifiesthat theschemeisvisibletoanyoneusingthatprojector workspace(depending
on where the scheme is stored). Be sure to check with other people using the project or
workspace before deleting or modifying a shared scheme.
Shared
You can drag the schemes to reorder their appearance in the dialog and the Scheme menu.
The Add (+) button allows you to create a new scheme or duplicate the selected scheme. The Remove (–)
button allows you to delete the selected scheme. The Action menu allows you to export the selected scheme
or import an exported scheme.
The Edit button dismisses this dialog and displays the selected scheme in the scheme editor.
If the Autocreateschemes checkbox isselected, whenyouaddanew target toyourproject,Xcodeautomatically
creates a scheme for it. If the checkbox isnot checked, thenyou canclick the Autocreate Schemes Now button
to have Xcode create new schemes for any targets that don’t have them.
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145Specify How to Build Your Product
Most developers can get by with the default build settings, except for the few that must be set—or at least
checked—for every project (see "Set the Basic Product Settings" (page 68)). You may have special needs,
however, that require anythingfromtweakinga settingor two to creatinganentirelynew buildconfiguration.
To check or change build settings, click the project in the project navigator to open the project editor.
Control-click in the left column of the project editor where the projects and targets are listed to see a list of
project editor help topics.
Figure 6-3 Project editor help topics
You can editbuild settings at theproject or target levels. Mostbuild settings have a system default. If you click
Levelsinthebuildsettingsheaderbar,Xcode shows youthe resolvedvalue for eachbuildsettingandindicates
with green highlighting the level at which the value was set.
Customize aspects of your product’s build process by editing its build settings.
To edit a build setting
1. In the project editor, select the project or target whose build setting you want to edit.
2. Click Build Settings at the top of the project editor.
3. Locate the build setting in the left column.
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1464. Set the value for the build setting in the right column.
See the HTML version of this 
document to view the video. document to view the video.
You set build settings at either the project level or the target level. To see all the levels of build settings,
select Levels rather than Combined.
The lowest level at which a build setting is defined takes precedence. If you define a build setting at the
project level, thedefinitionisset for thecorrespondingproject,andit’sappliedtoall thetargetsthatbelong
tothatproject.If youdefineabuildsettingat thetarget level, thedefinitionappliesonly tothecorresponding
target.
Definitions applied at the target level override definitions set at the project level. The level at which the
buildsettingisdefinedishighlightedingreen. For example, at thebeginningof the video, the Architecture
build setting is highlighted in green at the default level. At the end of the video, after the setting has been
redefined at the target level, the Architecture build setting is highlighted in green at the target level.
If you have changed or customized a setting, it’s shown in boldface.
The video shows changing the compiler build setting for a target.
You can see documentation on a build setting in the Symbol inspector in the utility area.
Find concise documentation for a build setting using Quick Help.
To see documentation on a build setting
1. Click Build Settings at the top of the project editor.
2. Display the Symbols inspector.
3. Select a build setting.
4. View the documentation under Quick Help in the Symbols inspector.
See the HTML version of this 
document to view the video. document to view the video.
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147Quick Help provides a persistent location for build setting documentation without taking your focus away
from the build settings pane. Whenever you select a build setting, Quick Help displays information about
that item.
The video shows viewing information on a build setting in Sketch.
Alternative: Option—double-click a build setting to open Quick Help in a separate window.
Unlike Quick Help in the utility area, the Quick Help window is not persistent.
Control the Order in Which Xcode Builds Your Products
Xcode detects when one of your products is dependent on another and automatically builds them in the
correct order. However, in the unusual event that you need to control the order in which Xcode builds your
products, you can create explicit target dependencies by using the Build Phases pane of the project editor.
Ensure that targets are built in the proper order using target dependencies. In a complex project, you may
have several targets that create related products. Frequently, these targets need to be built in a specific order.
To ensure products are built in the correct order
1. In the project editor, select the target to which you want to add a dependency.
2. Click Build Phases at the top of the project editor.
3. Open the Target Dependencies section.
4. Click the Add (+) button to add a target dependency.
5. Select a target from the list and click Add.
See the HTML version of this 
document to view the video. document to view the video.
Forexample,aproject foraclient-serversoftwarepackagemaycontaintargetsthat createaclientapplication,
a server application, tools that provide command-line interfaces to the client and server, and a private
framework that all the other targets use. For the project to build correctly, the private framework needs to
be built before the other targets—that is, the other targets have a dependency on the private framework.
The video illustrates adding a private framework to the client application target’s dependency list.
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148The Build Phases pane of the project editor also lets you specify the order in which files are compiled and
linked, specify which bundle resources are copied and in what order, and so forth. You can drag the build
phases into a different sequence if you wish, and you can drag the individual files in each build phase into
whateverorder you want. Doingsois advisableonly if youhave agoodreasontodosoandknow exactly what
you’re doing.
The Build-and-Run Workflow
This section describes each of the steps in the build-and-run workflow.
Specifying the Buildtime Environment
Whenyoubuildyourapp,Xcodeusesabuildenvironmentmadeupof frameworks,libraries,apps, command-line
tools, and other resources. Each revision of the iOS SDK makes improvements to this environment to, for
example, add user-interface features or improve compilers and resource-processing tools. In addition to these
resources, you can specify whether you want to build your app to debug it or to distribute it to customers.
This section describes how to set your build-time environment.
Setting the SDK Used to Build Your App
One of the main factors that determine how Xcode builds your app is the SDK used to build it.
To specify the SDK to use to build your app, set the Base SDK build setting to the appropriate SDK.
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149Note: To ensure minimal reconfiguration of your projects as you adopt new SDK releases, instead
of a specific SDKrelease,set thebaseSDKfor yourprojectstoLatest iOS. This way yourproject always
uses the latest available SDK in the toolset.
Base SDK Missing
If your project has its Base SDK setting set to a particular iOS SDK release, when you open that project with a
later Xcode toolset distribution in which that SDK release is not available, the Base SDK setting has no valid
value. In this case, the issue navigator lists a Missing SDK issue, as shown in “Create User Interface Classes.” To
fix the Missing SDK issue, set the base SDK for the target to an available SDK release or to Latest iOS.
Figure 6-4 Project with a Missing SDK issue
Setting Your Code Signing Identity
When you build your app to run it on a device, Xcode signs it with a development certificate (also known as a
code signing identity) stored on your keychain. To learn how to obtain and install development certificates,
see “Provisioning a Device for Development” (page $@).
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150The Code SigningIdentitybuildsettingspecifies theprovisioningprofile andcode signingidentityXcodeuses
to sign your binary. Xcode looks for code signing identities in your default keychain.
The possible values for the Code Signing Identity build setting are:
● Don’t Code Sign. Choose this option to build only for a simulator.
● Automatic Profile Selector. Choose an option under this selector to select a provisioning profile whose
name starts with “iPhone Developer” or “iPhone Distribution.”
● Specific Profile. Choose the code-signing identity under a specific provisioning profile when your app
requires special entitlements. Expired or otherwise invalid provisioning profiles are dimmed and cannot
be used.
Figure 4-3 shows a set of options for the Code Signing Identity build setting with a provisioning profile
for specialized development selected.
Figure 6-5 Code Signing Identity options with a specialized provisioning profile selected
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151Project templates are configured to use the automatic selector to set the signing identity. You need to change
the value of the Code Signing Identity build setting only when your app uses a specialized provisioning profile.
See App Distribution Guide for details on using specialized provisioning profiles.
Important: If you need to use different code signing identities that have the same name, you must use a
separate Mac OS X user account for each identity.
Specifying the Runtime Environment
Three aspects of your app’s runtime environment are: where your app runs, what app-data is placed in its
sandbox, and what location or track the Core Location framework reports to it.
Specifying the Run Destination
Before building your app, Xcode has to know where you want to run it. You specify this run destination in the
Scheme toolbar menu. Using that menu you can switch from running your app in a simulator to running it on
your device to, for example, test the device performance of your app.
Whenyouplugintoyour Mac adevice witha validprovisioningprofile, itsnameandtheiOS versionit’srunning
appear as an option in the Scheme toolbar menu. Use the menu to switch between running your app on a
device or in a simulator.
Troubleshooting:
● "Device Not Listed as a Run Destination" (page 154).
● "Xcode Displays the “Unknown iOS Detected” Dialog When You Plug In a Device" (page 206).
Specifying the App Data
The Run action in a scheme determines the app data Xcode places in your app’s sandbox before running it.
Using a particular app-data archive is particularly useful in application unit tests, which check for the correct
operationof criticalunitsof code inyour application.Basingyour testsona knowndata set allows youperform
detailed unit tests without having to configure the test data in the tests themselves.
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152Note: Eachschemecanspecifyonlyoneapp-dataarchive.If youneedtousemorethanoneapp-data
archive regularly, define a scheme for each archive.
Important: In Run actions, you can specify only app-data archives that that are part of your project. See
"Add a New Nib File" (page 93) for details.
To specify the app data to place in the app’s sandbox before the app runs:
1. From the Scheme toolbar menu, choose the scheme you want to use.
2. Select the Run action.
3. From the Application Data pop-up menu, choose the app-data archive you want to use.
Specifying a Location or Track
To test a location-based app, you can specify a location or a track the run destination reports to the app when
it launches and as it runs.
A GPSeXhangeFormat(GPX) filespecifies a singlelocation(a single waypoint)or a track (anorderedcollection
of waypoints). When you simulate track, the simulator or the device reports the waypoints in the order they
are specified in the track.
To make a GPX file available for use in your project, add it to the project, or add a new GPX file to the project
and specify the location or track details.
Build Your App
Tostart thebuildprocess, chooseProduct > Build. If theBuildoptionisdimmed, choosea validrundestination,
as described in "First Responder " (page 82).
The activity viewer, in the middle of the workspace window toolbar, indicates the progress of the build and
whether there are build problems. If the build fails or produces warnings, you can view details about the build
in the log viewer:
1. Choose View > Navigators > Log to display the log navigator.
2. In the list on the left, select the build task for which you want to view details.
The log viewer in the editor area lists the operations that are part of the build.
If the build completes successfully, you can run your app as described in "Run Your App" (page 154).
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153Run Your App
To run your app, choose Product > Run.
When you run your app, Xcode places it in a simulation environment or on a device, and launches it.
When your app runs on a device, you can ensure that it performs as you intend, using all the capabilities of
your device. You should especially ensure that your app uses the device’s resources—CPU, memory, battery,
andsoon—asefficiently aspossible. See"TunethePerformanceofYour App" (page207) formoreinformation.
Note: To run your appon adevice, thedevice mustbe connectedto your Mac through a USB cable.
Troubleshooting: Building Issues
Device Not Listed as a Run Destination
If you have a project or workspace open and your plugged in device is not listed as a run destination in the
Scheme toolbar menu:
1. Ensure that the app’s targeted iOS version is equal to or greater than the iOS version installed on your
device. See “Specifying the Targeted iOS Version” (page $@), and “Installing iOS on a Device” (page $@)
for details.
2. Ensure that your device contains a valid provisioning profile. See “Provisioning a Device for
Development” (page $@).
3. Ensure that the version number of the iOS SDK your project uses is equal to or greater than the version
number of the iOS version on your device.
For example, ifXcode showsiOS SDK4.3but yourdevicehasiOS 5.0 installed, youneedtoinstall anXcode
version that includes iOS SDK 5.0 on your Mac.
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You can specify behaviors that affect your build and run workflow through the Xcode Behaviors preferences.
TheBehaviorspreferencespanelets youspecify whatshouldhappen whena varietyofeventsoccur (“Behaviors
preferences”)—including, but not limited to, scheme actions.
Figure 6-6 Behaviors preferences
For example, you can have Xcode display the debug area when your code pauses at a breakpoint, or Xcode
can display the issue navigator when a build fails. If you are searching for text or a symbol name in a large
project, youcansetpreferencestolet youknow whenthe searchhas completed, either withor without results.
Tip: In addition to the Behaviors preferences setting to create a snapshot, you can specify that Xcode create a
snapshot before a mass editing operation such as a refactoring transformation. To do so, select the Snapshots
pane in the File > Project Settings or File > Workspace Settings dialog.
You can name a tab and specify that tab as the display to use when an event occurs. Then you can set up the
display in that tab exactly as you want it. If the tab doesn’t exist when the alert is triggered, Xcode creates the
tab for you, set up as it was when you created it. For example, in “Behaviors preferences,” Xcode is configured
to play a sound and open a tab named SketchDebug when the run pauses (such as when a breakpoint is
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155triggered). The tab will have the debug area and debug navigator open. If you configure the tab to include an
assistant editor and to display the debug area with the log pane closed, then every time a breakpoint is
triggered, a tab named SketchDebug opens with those characteristics.
To name a tab
● To give a custom name to a tab, double-click the title of the tab and type the new name.
Tab names are case sensitive in the Show Tab field of the Behaviors preferences.
Xcode remembers the state of the named tab—including which window it was in—when it reopens the tab.
By naming a tab in a separate window, you can use the “Show tab” option in Behaviors preferences to
automatically open a new window.
To automatically open a new window
1. Open and name a new tab.
2. Drag the tab out of the workspace window to create a new window.
3. Set up the new window exactly as you want it.
4. In Behaviors preferences, select the event for which you want the new window to open.
5. For that event, select the Show tab checkbox and type the name of the tab.
You can also can design custom behaviors that are triggered by menu items or their key equivalents.
To create a custom behavior
1. In the Behaviors preferences pane, click the plus button at the bottom of the left column.
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1562. type the name of the new behavior and press Return.
3. Select checkboxes to specify what should happen when you invoke this behavior.
For example, youcancreate a "Unit Testing"behavior that creates a snapshot andruns yourunit tests. After
you’ve created a behavior, it appears in the Xcode > Behaviors menu.
You can assign a key equivalent for each of your custom behaviors.
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157To assign a key equivalent to a custom behavior
1. In the Key Bindings preferences pane, select the Customized tab to find the behavior for which you
want to assign a key equivalent.
2. Click the Key column on the line of the behavior in order to open a text field.
3. With the text field selected, press the keys you want to use for the key binding.
4. Click outside the text field to complete the operation.
Note: If you don’t click outside the text field and instead press a key (such as Return), Xcode
enters the key you pressed into the text field.
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158Tip: If the key binding you specify conflicts with another, a red circle with an exclamation mark appears at
the right edge of the key column. Xcode does not save the new key binding until you resolve the conflict.
Click the Conflicts tab to see the other command or commands that use the same key combination.
Manage App Data in iOS Devices
When an app is first installed on a device or in a simulation environment, iOS creates a sandbox (also known
as the app home directory) for it. As described in “File and Data Management” in iOS App Programming Guide,
an iOS app can access only files that reside in its sandbox.
Xcode doesn’t remove app data as it reinstalls an app. But you may need to erase that information as part of
testing your app the way users will use it. To do so, remove the app from the Home screen. See "Add Build
Rules" (page 72) for details.
You may also want to replace the app data in your app’s sandbox with a known configuration to test specific
conditions, such as when performing application unit tests. The first step is to create an archive of the app
data from a development device (you cannot generate app-data archives from simulators). Then you can
change the app data on your Mac and copy it back to the device.
To copy app data from a development device:
1. Plug in the device containing the app whose data you want to copy.
2. Copy the app’s data from the device.
After copying the app data to the file system, you can modify it to, for example, make changes that
wouldbe tedious todointhe appitself. Toaccess the contentsof the app-data archive, Control-click
the archive in the Finder and choose Show Package Contents.
If you want to use a particular configuration of your app’s data when you run the app, add the
appropriate app-data archive to your project, and specify that archive in the Run action of the
appropriate scheme. See “Specifying the App Data” (page 84) for more information.
To copy app data to a development device:
1. Plug in the device containing the app whose data you want to replace.
2. Copy the app data to the device.
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159To access your app’s simulation-environment sandbox, navigate to the directory ~/Library/Application
Support/iPhone Simulator//Applications in the Finder. Then open each directory
in the Applications directory to find your app’s binary file. Alongside the binary file are the directories that
make up your app’s sandbox, including Documents and Library.
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160There are five actions that you can perform with Xcode:
● Run
● Test
● Profile
● Analyze
● Archive
Each of these actions requires you to first build your code. Exactly what is built is specified by the scheme you
choose and how that scheme is configured. In addition to the Build pane in the scheme editor, which specifies
which targets are built for each action, there is a configuration pane for each action.
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Customize Product ActionsRun Your Application to Debug It
Although a scheme can specify any number of targets to be built when you click the action button, Xcode can
launch and debug only one executable at a time. Listing 3-2 shows the Info pane for the Run action.
Figure 7-1 The scheme editor Run pane
You can specify whether to use a debug or release build configuration (or any other build configurations you
added) and which debugger to use.
Debug vs. Release Builds
A debug build includes symbols that can be used by a debugger to display your source code when your
program stops at a breakpoint and to show you the values of your variables at that point. For a release build,
you normally want to strip that information out, because the debug information makes it very easy to
reverse-engineer the program. Release builds also typically do code optimization that isn’t done for debug
builds.BecausetheRunactionisnormallyusedfordebugging,mostdevelopersuseadebugbuildconfiguration
for the Run action. However, you might occasionally want to build and run your application with the release
configuration to see what size your application will be and to make sure there are no problems introduced by
the code optimization; that is, to make sure your application runs as you expect.
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162Arguments and Environment Variables
Otherpanesfor theRunactionlet youprovidearguments andenvironment variablestopasstoyourexecutable
on launch, and a number of diagnostic options, such as for memory management and logging.
Specify runtime arguments for your application when you run it in Xcode.
To run your application with arguments
1. From the Scheme toolbar menu, choose a scheme.
2. From the same menu, choose Edit Active Scheme to display the scheme dialog.
3. In the left column, select Run.
4. To specify runtime arguments, click Arguments.
5. Click OK.
6. Click the Run button or choose Product > Run.
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163Schemes contain a Run action that affects what happens when you choose Product > Run. To specify
runtime arguments, click the Arguments tab. You can specify arguments passed on launch, environment
variables, and modules for which to load debug symbols.
During the test and debug phases of your product development, configure a scheme to run your application
withvariousmemorymanagementdiagnostics andloggingoptions enabled. Schemeshave aRunaction with
a Diagnostics pane that allows you to choose from a selection of runtime diagnostic tools.
To run your application with diagnostics
1. From the Scheme toolbar menu, choose a scheme.
2. From the same menu, choose Edit Active Scheme to display the scheme dialog.
3. In the left column, select Run.
4. To specify runtime diagnostics, click Diagnostics.
5. Click OK.
6. Click the Run button or choose Product > Run.
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164Select thetoolsthat you wantXcodetouse.Youcanview output fromthesetoolsinthedebugareaconsole
and in the debug log in the log navigator.
Memory Management options:
● Enable Scribble. Fill allocated memory with 0xAA and deallocated memory with 0x55.
● Enable Guard Edges. Add guard pages before and after large allocations.
● Enable Guard Malloc. Use libgmalloc to catch common memory problems such as buffer overruns
and use-after-free.
● Enable Zombie Objects. Replace deallocated objects with a “zombie” object that traps any attempt
to use it. When you send a message to a zombie object, the runtime logs an error and crashes. You
can look at the backtrace to see the chain of calls that triggered the zombie detector.
Logging options:
● Distributed Objects. Enable logging for distributed objects (NSConnection, NSInvocation,
NSDistantObject, and NSConcretePortCoder).
● Garbage Collection Activity.Enablevariousloggingfacilitiesinthegarbage-collectedmemoryallocator.
Log when a collection occurs, log when new regions are allocated, and log all weak reference
manipulations.
● Malloc Stack. Record stack logs for memory allocations and deallocations.
● Log Exceptions. Log Objective-C runtime exception handling.
● Log DYLD API Usage. Log dynamic-linker API calls (for example, dlopen).
● Log Library Loads. Log dynamic-linker library loads.
Debugger options:
● Stop on Debugger() and DebugStr(). Enable Core Services routines that enter the debugger with a
message. These routines send a SIGINT signal to the current process.
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165Location Simulation
Youcansimulatelocationsother thanyour current locationiniOS appsthatuse CoreLocation. Toset a location,
choose Edit Scheme from the scheme selector in the toolbar, select the Run action, and click the Options tab.
You can then choose a location from the Location menu (“Choosing a location in the scheme editor”). To set
a location in the debug bar, see "Set a Location in the Debug Bar" (page 186).
Figure 7-2 Choosing a location in the scheme editor
Run Unit Tests to Find Regressions
Whenever you make changes to your code, there’s a chance that you’ve introduced bugs and that the code
will no longer run as expected. As a quality control measure, you can create programs, called unit tests, that
automatically exercise the featuresof your applicationandcheck the results. Eachunit test is a separatebundle
containing code for a set of test cases, each of which exercises some subset of your application’s features. Test
cases are organized into test suites. In code, you create classes that are subclasses of the SenTestKit test
suite base class. Each such class in the bundle is a test suite, and any methods in those classes that begin with
the string test are the test cases.
Choosing the Test action causes Xcode to build the targets you specified for the test action in the Build pane
of the scheme editor and then executes the test cases you enabled in the Test pane. Normally, you create one
or more test targets that are separate from your application product targets.
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166The Xcode development installation includes a framework for testing Objective-C code—the senTestingKit
framework—which provides methods you can use to exercise methods in your code and test the results.
For references and more reading on unit tests and the senTestingKit framework, see the Sen:te website.
For details about using unit tests in your project, see Xcode Unit Testing Guide.
Profile Your Application to Find Problems and Optimize Your Code
You can profile your application in order to find problems and optimize your code. Do so using the built-in
Instruments application. Instruments runs your executable, collecting and displaying data that you can use to
find problems such as memory leaks and unguarded file system access. It also helps you optimize aspects of
execution, such as CPU use, file activity, and the use of threads. There are also specialized instruments for
specific frameworkssuchas Core Data and OpenGL. Althoughyoucanrunindividual instruments, it’s common
to run sets of instruments together, such as several instruments that monitor overall system activity. The
Instruments application comes with a set of templates, each of which includes one or more instruments. You
can also define your own templates. For more information on the Instruments application and instruments
templates, see Instruments User Guide.
You use the scheme editor’s profile pane to specify which template Instruments should use when you choose
the Profile action.
To specify an Instruments template for the Profile action
1. Open the scheme editor.
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3. Choose an instrument template from the Instrument pop-up menu.
The default choice is Ask on Launch, which causes Instruments to display its template chooser dialog
when it starts up.
If you select a blank template from the Instruments template chooser, you can drag one or more individual
instrumentsintotheInstruments window toberun withyourapplication.Youcansavethesetof instruments
as a custom template, in which case it becomes available as a choice in the Instrument pop-up menu of
the Profile pane.
Perform Static Analysis To Find Semantic Problems
The Analyzeactionperformsastaticanalysisof your code.Theonlyoptionfor the Analyzeactioninthescheme
editor is whether to analyze a debug or release build. To specify which targets should be included in the
analysis, use the checkboxes in the Analyze column of the Build pane. Static analysis is discussed in "Locate
Possible Semantic Problems" (page 171).
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168Create an Archive for Sharing or Submitting Your Program
The Archive action creates an application bundle you can use to share your program with others or to submit
your application to the App Store. Because it’s unusual to share a debug version of an application, most
developers set the build configuration to Release in the Archive pane of the scheme editor. To distribute
frameworks, plug-ins, and other targets with your application, select the checkboxes for those targets under
the Archive column in the Build pane of the scheme editor. You probably don’t want to distribute unit tests
with your application, on the other hand, so you should not select the checkbox for the test target in the
Archive column.
For more information on the use of archives, see "Distribute Your App" (page $@).
Initiate a Product Action
You can initiate an action in several ways.
To initiate an action
Do one of the following:
● Click and hold the action button at the left end of the toolbar, then choose the action you want from
the pop-up menu.
If you click this button without holding it, Xcode initiates the action currently displayed by the button.
● Choose an action from the Product menu.
● Use a keyboard shortcut.
There are keyboard shortcuts for every action except Archive (open the Product menu to see the list).
Tip: Hold down the Option key to see additional shortcuts.
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cause the targets specifiedby the Buildpane of the scheme tobebuiltbeforeperformingthe specifiedaction.
Other items in the menu allow you to build without other actions, or to perform the other actions using the
last build without building again.
To open the scheme editor before initiating an action
1. Hold down the Option key and Choose Product > Profile.
The scheme editor opens to give you the opportunity to check or change the scheme settings before
you executing the action.
The OKbuttonat thebottomof theschemeeditor isreplaced withtwobuttons: thenameof theaction
(here, Profile) and Done.
2. Click the action button in the scheme editor.
Any changes you made to the scheme are saved and the action is carried out using the new settings.
Tip: Click Done tosave anynew scheme settings andclose the scheme editor withoutbuilding
the application.
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170Xcode provides all the facilities you need to make sure that your code is correct, that it performs well, and it
uses device and network resources appropiately.
Ensure that Your Code Is Correct
Unit tests help you write robust and secure code by testing your application’s functionality. Xcode provides
aneasy-to-useandflexibleunit-testingenvironment forensuringthat your codecontinuesto work asdesigned
as you make changes to it.
You can perform two types of unit tests: logic tests and application tests. With logic tests you can ensure that
your code works at the lowest level, usually methods and single classes. With application tests you make sure
that your app’s classes work as designed within the app.
Xcode makes it easy to create projects and products that include unit-testing support. But you can also add
unit testing to existing projects and products.
To learn how to integrate unit testing in your project, see Xcode Unit Testing Guide.
Find Coding Mistakes
At any time in your code development, you can run the static analyzer to find potential semantic problems in
your code. In addition, when you build your project, the compiler returns messages, warnings and errors that
you can use to find and correct mistakes in your code.
Note that if you use the LLVM compiler, Fix-it scans your code and flags possible errors as you type ("Have
Fix-it Flag Errors as You Type" (page 117)).
Locate Possible Semantic Problems
Use static analysis to examine the semantics of your code to find potential problems with your program logic.
Xcode lets you perform the analysis, examine the results, and edit your source files all within the workspace
window.
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Debug and Tune Your AppYou run the static analyzer by selecting the project you want to analyze in the project navigator and then
choosing Analyze from the Product menu. You can use the Build pane of the scheme editor to specify which
targets are included in the analysis.
Tip: If you want to open the scheme editor to set options before running the static analyzer, hold the Option
key while choosing Product > Analyze.
Find flaws—potential bugs—in the source code of a project with the static analyzer built into Xcode. Source
code may have subtle errors that slip by the compiler and manifest themselves only at runtime, when they
could be difficult to identify and fix.
To perform static code analysis
1. Choose Product > Analyze.
2. Select an analyzer message in the issue navigator.
3. Click the corresponding message in the source editor.
4. Use the pop-up menu in the analysis results bar above the edit area to study the flow path of the flaw.
5. Edit the code to fix the flaw.
See the HTML version of this 
document to view the video. document to view the video.
The Xcode static analyzer parses the project source code and identifies these types of problems:
● Logic flaws, such as accessing uninitialized variables and dereferencing null pointers
● Memory management flaws, such as leaking allocated memory
● Dead store (unused variable) flaws
● API-usage flaws that result from not following the policies required by the frameworks and libraries
the project is using
Youcansuppressfalsepositivemessagesfromtheanalyzerusingassertions, attributes,orpragmadirectives.
When you analyze a project for the first time, you may uncover a lot of issues. But if you run the static
analyzer regularly and fix the flaws it uncovers, you should see fewer problems in subsequent analyses.
Analyze early; analyze often. It’s good for the code.
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172Note that if the static analyzer reports no problems, you can't assume that there are none. The tool cannot
necessarily detect all the flaws in the source code.
The video shows the process of looking at a flaw in the source file SKTText.m.
Tip: Choose Product > Clean to remove the analyzer messages from the issue navigator.
Locate and Display Build Issues
You can build and run the executable specified by the active scheme by clicking the action button at the left
end of the toolbar. Other options, such as running without building or building without running, are available
in the Product menu.
Figure 8-1 The issue navigator
If the compiler finds any problems while building, the issue navigator opens. You can display problems by file
or by type (Figure 8-1). Filters at the bottom of the navigator let you display only issues from the latest build,
only issues associated with the current scheme, only errors (suppressing any warnings), or only issues that
include text matching a string you enter in the filter field.
To navigate through build issues
Do one of the following:
● Use the issue pop-up menu at the right end of the jump bar.
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173The issue menu appears as a yellow triangle if the most serious issue listed is a warning ( ) or as a
red octagon if any errors are listed ( ). Choose an error from the menu or use the arrows to cycle
through the errors.
● Select any of the errors or warnings in the issue navigator to display in the source editor the line of
code where the problem was discovered.
Click the number at the right margin of an issue to see a list of all the issues associated with the line
of code.
Debug and Tune YourApp
Ensure that Your Code Is Correct
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
174To view build issues with the log navigator
1. Select a build in the build log.
The build results are displayed in the editor area.
2. Open an assistant editor and set it to Referenced Files.
3. Select an issue in the log to see it displayed in the assistant editor.
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1754. Double-click an issue in the log to see it displayed in a separate window or tab (depending on the
double-click setting in the General pane of Xcode Preferences).
Whereas the issue navigator is the common place to go to see build errors and warnings, build logs are where
you can see details about what happened during a build. For example, if you want to make sure files were
built in the right order, ensure that a particular file got rebuilt, or track down some advanced project
configuration problem, you can get the information you need in the build log.
To view build result details
Do one of the following:
● Click the list icon( ) at the endof abuildcommandline inthebuildlogtosee the fullbuildcommand
and results.
● Option-click a build issue to open the full build results to that issue.
The issue highlights briefly when the full build results open.
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176As of Xcode 4.1, you can select what kind of content to view when debugging: source only (when available),
disassembly only, or source and disassembly. The disassembly is the set of assembly-language instructions
seen by the debugger while your program is running. Viewing the disassembly can give you more insight into
what your code is doing when it’s stopped at a breakpoint. By viewing the disassembly and source code
together, you can more easily relate the instruction being executed with the code you wrote.
To view disassembly while debugging
Do one of the following:
● Choose Product > Debug Workflow > Show Disassembly When Debugging.
The disassembly is displayed in the editor pane.
● Open an assistant editor and choose Disassembly from the Assistant pop-up menu in the assistant
editor jump bar.
The source and disassembly are shown in the split editor pane.
Manage Breakpoints
Although you can use the debugger to pause execution of your program at any time and view the state of the
running code, it's usually helpful to set breakpoints before running your executable so that you can stop at
known points and view the values of variables in your source code.
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177Add and Activate Breakpoints
To set breakpoints, open a source-code file and click in the gutter next to the spot where you want execution
to stop. When you add a breakpoint to the code, Xcode automatically activates breakpoints, as indicated by
the breakpoint-state button in the toolbar (active: inactive: ). You can toggle the state of breakpoints
at any time by clicking the breakpoint-state button. You can also disable an individual breakpoint by clicking
its icon. To remove a breakpoint completely, drag it out of the gutter.
Youcansetseveraloptionsforeachbreakpoint,suchas a condition, thenumberof timestopassthebreakpoint
before it’s triggered, or an action to perform when the breakpoint is triggered.
To set breakpoint actions and options
1. Inthebreakpointnavigator, Control-click thebreakpoint,andchooseEditBreakpoint fromtheshortcut
menu.
2. Set the actions and the options for the breakpoint in the breakpoint editor.
Specify what Xcode does when a breakpoint is triggered with the breakpoint editor.
Each breakpoint type has specific properties that define it, such as condition and ignore count (for file line
breakpoints), symbolname (for symbolicbreakpoints), andexceptiontype (for exceptionbreakpoints). But
all breakpoint types share two properties:
● Action: Specifies what actions Xcode performs when the breakpoint is triggered. You can have Xcode
execute an AppleScript script or a shell or debugger command, log or speak a message, or emit a
sound.
● Options: Specifies additional breakpoint behavior, such as whether to continue program execution
after performing actions.
The screenshotshows a file linebreakpoint that isignoredthe first five timesit ishit. Subsequenthitstrigger
the breakpoint, which causes Xcode to emit a sound and continue program execution.
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178In addition to conditional breakpoints, which are triggered when a specific condition is met, you can create
breakpointsthat aretriggered whena specific typeofexceptionisthrownor caught, andsymbolicbreakpoints,
which are triggered when a specific method or function begins execution.
Add an exception breakpoint to your project in the breakpoint navigator.
To add an exception breakpoint
1. In the bottom-left corner of the breakpoints navigator, click the Add button.
2. Choose Add Exception Breakpoint.
3. Choose the type of exception from the Exception pop-up menu.
4. Choose the phase of the exception handling process at which you want program execution to stop.
5. Click Done.
The Exception pop-up menu specifies the type of exceptions on which you want execution to stop:
● All. Stops on all exceptions.
● Objective-C. Stops on Objective-C exceptions.
● C++. Stops on C++ exceptions.
To stop on a particular C++ exception, specify the exception name.
The screenshot shows the properties of an exception breakpoint.
To add a symbolic breakpoint
1. In the bottom-left corner of the breakpoint navigator, click the Add button.
2. Choose Add Symbolic Breakpoint.
3. Enter the symbol name in the Symbol field.
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1794. Click Done.
Adda symbolicbreakpoint toyourproject inthebreakpointnavigator. Symbolicbreakpointsstopprogram
execution when a specific function or method starts executing.
You can specify the symbol as:
● A method name. For example, pathsMatchingExtensions:.
● A method of a particular class. For example, [SKTLine drawHandlesInView],
people::Person::name().
● A function name. For example, _objc_msgForward.
If the symbol is declared in more than one library, enter the name of the appropriate library in the Module
field.
The screenshot shows the properties of a symbolic breakpoint.
Edit Breakpoints
Forexistingbreakpoints,youcaneditoptionsor changetheirscope—that is, theprojector workspacein which
the breakpoint appears.
To edit breakpoint options
1. Open the breakpoint navigator and Control-click the breakpoint whose options you want to edit.
2. From the shortcut menu, choose Edit Breakpoint.
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1803. In the Condition field of the options dialog, specify an execute condition for the breakpoint (if any).
Thebreakpoint istriggeredonly if the conditionistrue (for example, i == 24).Youcanuse any variables
that are in the current scope for that breakpoint.
You must cast an function calls to the appropriate return type.
4. Specify values for any other actions you want to set and click Done.
By default, a new breakpoint is local to the workspace you have open. If you add the project containing that
breakpoint toanother workspace, thebreakpoint isnot copiedtothenew workspace.Youcanassignbreakpoints
to other scopes, however. If you move a breakpoint to User scope, it appears in all of your projects and
workspaces. If you move a breakpoint to a specific project, then you see this breakpoint whenever you open
that project, regardless of which workspace the project is in.
To change the scope of a breakpoint
1. In the breakpoint navigator, select the breakpoint or breakpoints you want to assign to a new scope.
2. Control-click one of the breakpoints, and from the shortcut menu, choose Move Breakpoints To.
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1813. If you have a workspace window open, your choices include Workspace, User, and all of the projects
in the workspace:
If you have a project open without a workspace, your choices are User and the project you have open:
4. Choose Workspace to have the breakpoint appear only in this workspace. Choose User to have the
breakpoint appear in all your workspaces and bare projects. Choose a specific project to have the
breakpoint appear whenever that project is open, regardless of which workspace it’s in.
5. Your choice is reflected in the organization of the breakpoint navigator.
Share Breakpoints
You can share any breakpoints with other users.
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182To share breakpoints
1. In the breakpoint navigator, select the breakpoint or breakpoints you want to share.
2. Control-click one of the breakpoints, and from the shortcut menu, choose Share Breakpoints.
3. Xcode moves the shared breakpoints into their own category in the breakpoint navigator:
A breakpoint with Userscopecannotbeshared. If youselect a Userbreakpoint andchooseShareBreakpoint
fromtheshortcutmenu,Xcodemovesthebreakpoint tothelocal (Workspaceor individualproject) category
and shares it.
Set Preferences for Breakpoint Behavior
The “Run pauses” option in Behaviors preferences specifies what Xcode does when a breakpoint is triggered
and the running application pauses. By default, Xcode opens the debug navigator and debug area, showing
the location of the breakpoint in your code and the status of the application’s threads and stacks. However,
you can customize this behavior, specifying various sorts of behaviors (such as a sound or announcement),
which navigator to open, and whether to navigate to the first new issue. You can even design a tab with the
layout you prefer, name the tab, and have Xcode re-create it when a breakpoint is triggered. For more
information on Behaviors preferences, see "Customize Your Build and Run Workflow" (page ?).
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183Customize the Debug Area
If you pause execution or a breakpoint is triggered, the debug area opens, displaying the values of variables
and registers plus the debug console (Figure 8-2). You can use the buttons at the right end of the debug area
toolbar to display both the variables and console panes or to hide either one.
Figure 8-2 The debug area
The Variables Pane
The variables pane displays variables and registers. You specify which items to display using the pop-up menu
in the top-left corner of the variables pane:
● Auto displays only the variables you’re most likely to be interested in, given the current context.
● Local displays local variables.
● All displays all variables and registers.
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184Use the search field to filter the items displayed in the variables pane.
The Console Pane
The console pane displays program output and lets you enter commands to the debugger tool. You specify
the type of output the console displays with the pop-up menu in the top-left corner of the console pane:
● All Output displays target and debugger output.
● Debugger Output displays debugger output only.
● Target Output displays target output only.
Control Program Execution
When you execute a program from Xcode, the debug bar appears at the bottom of the editor pane. You can
use the debug bar to control program execution and to navigate through threads and stacks. You can also
step through code and control execution in the source editor and you can suspend a thread in your running
application.
To make it easier todebug full-screen applications, you can setXcode to a window-in-front mode that lets you
control program execution without obscuring your program window.
Step Through Code with the Debug Bar
The debug bar includes buttons to:
● Open or close the debug area
● Pause or resume execution of your code
● Stepover; that is, execute the current lineof code andif it is a routine) returntothenext line inthe current
file
● Step in; that is, execute the current line of code and (if it is a routine) jump to its first line
● Stepout of a jumped-to routine; that is, complete the current routine and stepto the next routine orback
to the calling routine
Control-click to step through your code by assembly language instruction instead of by statement. The step
icons change to show a dot rather than a line under the arrow.
Control-Shift-click to perform the action in the active thread while holding other threads stopped. The step
icons show a dashed rather than solid line under the arrow.
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185Tip: Toseewhichkey combinationperformswhichaction, look intheProduct> Debugmenuwhileadebugging
session is in process.
Set a Location in the Debug Bar
if you are running an application for iOS 5.0 or later that uses Core Location, the debug bar has a location
drop-down menu (Figure 8-3). To set a location in the Run action of the scheme editor, see "Location
Simulation" (page ?).
Figure 8-3 Choosing a location in the debug bar
Step Through Code in the Source Editor
Whileyour codeispausedat abreakpointorbecauseyouclickedthepausebutton, youcancontinueexecution
or step through your code in the source editor.
To continue execution to a specific line of code, hold the pointer over the gutter next to the target code line
until the continue-to-here icon appears, then click the icon.
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186Tosteptothenext instruction,holdthepointerover thegutternext totheinstructionpointeruntil thestep-over
icon appears, then click the icon.
Suspend a Thread
Suspend a thread to prevent it from running during your debugging session. You might suspend a thread if
the thread is about to crash or if you want to prevent it from doing work that could interfere with the rest of
your application.
To suspend a thread in your running application
1. Pause your application’s execution, or wait for it to hit a breakpoint.
2. In the Debug navigator, Control-click the desired thread.
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1873. In the contextual menu, choose Suspend Thread.
A suspended thread does not run when you step through your code or continue execution. The debug
navigator places a red status icon next to suspended threads.
Toresumeathreadthat is currentlysuspended, Control-clickitandselectResumeThreadfromthecontextual
menu.
The screenshot shows the Suspend Thread command in the contextual menu of the debug navigator.
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188Important: Although suspending threads can help you debug your application, it can also have other
consequences.Forexample,suspendingathreadthatholdsalock couldcauseother threadstodeadlock.
Set Xcode Window Behavior
When you run your application from Xcode in order to debug it, you have both Xcode and your application
open on your monitor. In some cases—for example, when you have a full-screen application and only one
monitor—you might want to keep Xcode behind your application and use keyboard shortcuts to control
window execution. ChooseProduct >Window Behavior > XcodeBehindtokeepXcodebehindyourapplication.
If youneedtobe able tosee thedebugarea andotherdebugginginformation whenyoustopyour application
or it pauses at a breakpoint, however, you can instead choose Product > Window Behavior > Xcode In Front
tokeepXcode infrontof your application. Inthis case, while your applicationisrunning, theXcode application
shrinks to a minimum size, displaying a minimum set of controls. In Figure 8-4, the Xcode window is indicated
with a red box.
Figure 8-4 Xcode In Front window mode while the executable is running
Click the Console button to open the debug console while the application is running. Click the Focus button
to allow the focus to switch between the application and Xcode.
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189Whenyoupause executionor yourprogramhits abreakpoint,Xcode expandstoshow thedebugpane (Figure
8-5). When you continue execution, Xcode shrinks again.
Figure 8-5 Xcode In Front window mode while the executable is paused
Examine Threads, Stacks, Variables, and Memory
When you pause execution of your code (see "Control Program Execution" (page 185)) or the running code
triggers a breakpoint, Xcode opens the debug navigator, displaying the threads that were running when
execution paused. Under each thread is the stack at that point in program execution. You can examine the
threads andstacks in thedebugnavigator, usingthe filters at thebottom of the navigator to control the scope
of threads and stacks so you can concentrate on the level of detail that is most useful to you. You can also
navigate through threads and stacks in the debug bar of the debug area.
You can view variable values in the debug area or source editor, and you can use the debug area and editor
pane together to view the contents of memory locations.
To view threads and stacks in the debug navigator
1. Set breakpoints at the locations where you want to examine threads and stacks.
2. Choose Run from the Product menu (or click the Run button).
3. When execution pauses, select a stack frame in the debug navigator.
The corresponding source file or disassembled object code is shown in the source editor.
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190The slider at the bottom of the debug navigator controls how much stack information the threads and
stacks navigator displays. At the left end of the slider, the debug navigator shows only the top frame
of each stack. At the right end, it shows all stack frames. Click the button at the left end of the slider (
) to toggle between displaying all the active threads or only threads that have your code in them (as
opposed to system library code). The figure shows the debug navigator when execution has stopped
at a breakpoint.
To view threads and stacks in the debug area
1. With the debug area open, run your application.
2. Pause your application’s execution, or wait for your code to stop at a breakpoint.
3. Choose a thread from the pop-up menu in the debug bar.
4. Examine the corresponding source or assembly code.
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191The debug area lets you examine the threads and stacks of a program being debugged. When you select
athreadorastack withinathreadinthedebugbar,Xcodedisplaysthecorrespondingsourcefileorassembly
code in the main editor.
The screenshot shows the debug area while choosing a thread and a stack frame to examine.
Alternative: You can also view threads in the debug navigator.
Filter threads andsymbolstoremoveextraneousinformationandfocusonyourowncodeduringadebugging
session. The debug navigator sports two controls for filtering extraneous threads and program symbols: the
thread filter and the call stack slider.
To filter threads and symbols in the debug navigator
1. Pause your application’s execution or wait for your code to stop at a breakpoint.
2. Use the thread filter button to hide threads that are not relevant to debugging.
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1923. Use the call stack slider to adjust the amount of detail shown for each thread.
The thread filter button shows or hides threads that may not be relevant to debugging your code right
now. Examples of such threads include the heartbeat and dispatch management threads and any threads
that are idle and not currently executing any specific application code. Hiding these threads allows you to
focus on the threads that are doing actual work for your application.
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193For each thread, the call stack slider dynamically collapses or expands the list of symbols displayed by that
thread. Collapsing the list helps you focus your debugging effortsby hiding calls that are far removed from
your code. (The presence of hidden symbols is indicated by a dotted line in the stack frame.) Expanding
the list lets you see the precise set of calls that occurred to reach the current stopping point.
The screenshots show the debug navigator in two states. The screenshot on the left shows the debug
navigator withthethreadfilter turnedoff andthecallstack sliderset toshow allstack frames.Thescreenshot
on the right shows it with the thread filter turned on and the call stack slider set to show only the most
relevant stack frames.
Note: Filteringappliesonly tothreads andtheir contents anddoesnot apply toviewedmemory
locations.
To view memory locations
1. In the debug area, Control-click the variable whose memory you want to view.
2. Choose View Memory of “variable” from the shortcut menu.
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1943. Use the debug navigator to select from among the viewed memory locations.
View memory locations to examine the raw contents of program variables. When you view a new memory
location from the debug area, an entry is added to the debug navigator and selected. The contents of the
selected memory entry are then displayed in the memory browser in editor pane.
The bottom of the memory browser contains controls you use to navigate the memory and customize its
display:
● Address. Specifies the beginning address of the memory displayed in the memory browser.
● Memory Page. Moves back or forward a memory page.
● Number of Bytes. Specifies the number bytes in a memory page.
● Byte Grouping. Specifies the size of the memory chunks displayed.
Memory locations are valid only while the application is running in the current debugging session. When
you quit the application, Xcode removes all memory entries from the debug navigator and discards them.
To remove a memory entry while you are still debugging, select the entry and press Delete.
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195Inspect the value of a variable in a datatip to uncover a problem in the source code.
To view variable values in the source editor
1. Place a breakpoint in the method you want to investigate.
2. Run the project.
3. When execution stops, place the pointer on a variable that comes before the breakpoint.
4. In the datatip that appears, inspect the current value of the variable.
See the HTML version of this 
document to view the video. document to view the video.
You can also view the values of variables in the variables pane of the debug area.
The video illustrates inspecting the value of an integer variable in the method windowDidLoad.
Capture OpenGL ES Frames
The debugging features for iOS OpenGL ES applications includes a facility for capturing and analyzing frames.
Whenframecaptureisenabledintheschemefor theapplication, thedebugbarprovides a control forentering
the OpenGL ES frame debugging view.
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196To enable this feature, you must run the app on a device and the device must be running iOS 5.0 or later. Set
the destination in the scheme menu to an iOS device and choose Edit Scheme from the scheme selector in
the toolbar. Select the Run action, click the Options tab, and choose either Automatically Enabled or Enabled
from the OpenGL ES Enable Frame Capture pop-up menu (Figure 8-6).
Figure 8-6 Enabling OpenGL ES frame debugging
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197When you build and run your OpenGL ES application, the debug bar includes a frame capture button (Figure
8-7). Click that button to capture a frame.
Figure 8-7 Frame capture button
You can use OpenGL frame capture to:
● Inspect OpenGL ES state information.
● Introspect OpenGL ES objects such as view textures and shaders.
● Step through draw calls and watch the changes with each call.
● Step through the state calls that precede each draw call to see exactly how the image is constructed.
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198Figure 8-8 shows a captured frame. The debug navigator has a list of every draw call and state call associated
with that frame. Thebuffers associated with the frame are shown in the editorpane, and the state information
is shown in the debug pane.
Figure 8-8 OpenGL ES frame capture
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199You can stepthroughdraw calls in thedebug navigator, orby using thedouble arrows andslider in thedebug
bar (Figure 8-9).
Figure 8-9 Controls for stepping through draw calls
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200When you use the draw call arrows or slider, you can have Xcode select the stepped-to draw call in the debug
navigator. To do so, Control-click below the captured frame and choose Reveal in Debug Navigator from the
shortcut menu (Figure 8-10).
Figure 8-10 Shortcut menu
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201You can also use the shortcut menu to toggle between a standard view of the drawing and a wireframe view
(Figure 8-11). The wireframe view highlights the element being drawn by the selected draw call.
Figure 8-11 Wireframe view
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202Open the Assistant editor to see the objects associated with the captured frame. In the Assistant editor you
can choose to see all the objects, only bound objects, or the stack. Open a second Assistant editor pane to see
both the objects and the stack for the frame at the same time (Figure 8-12).
Figure 8-12 Frame capture with two Assistant panes
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203Double-click an object in the Assistant editor to see details about that object. For example, if you double-click
a texture object, you can see the texture in detail. Figure 8-13 shows the data in a vertex array (VAO) object.
Figure 8-13 Vertex Array Object detail
Fix Bugs in Your App
Thissectionprovides anoverview of theXcodedebuggingfacilities anddescribeshow toview consoleoutput.
Part of your debugging workflow may require viewing or manipulating data your app writes in its sandbox.
For example, you may need to edit the data that the app has stored so you can recreate a particular condition
to test it. See "To design and implement user interfaces at the same time" (page 96) for details about
manipulating your app’s data.
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204Debugging Facilities Overview
Xcode provides several integrated debugging facilities, which provide both a general view of your app’s code
and details when you need them.
● The debug navigator. This navigator (on the left of the workspace window) shows your app’s threads
and stack frames, which you use to navigate your running code. Selecting an item in the debug navigator
opens its file in the source editor.
● The source editor. You use the source editor (in the editor area) to debug your code right in your code.
It provides most of the debugging features you need. You can:
● Set breakpoints
● View the value of variables by holding the pointer over them
● Continue execution up to a particular code line
● Step in to, out of, or over function or method calls
● The debug area. The debug area (below the source editor) presents a variables list and a console pane
to show your program’s console output. You can also issue debugger commands in the console pane. You
usethedebugbar,at thetopof thedebugarea, tocontrol yourprogram’sexecutionbypausing, continuing,
and stepping through code.
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205Important: To debug an app successfully on a device, ensure that the version number of the iOS SDK your
project uses is equal to or greater than the version number of the iOS version on your device. Installing the
latest public version of Xcode from the App Store or the latest beta version from http://developer.apple.com/devcenter/ios should suffice.
Viewing Console Output and Device Logs
The iOS frameworks, such as UIKit, send log entries to the console to indicate, among other things, when an
unexpected event occurs. You can emit console messages in your iOS apps, too. One way to emit console
messages is to use the NSLog function. Console logs can help you analyze your app’s logic and track down
bugs.
When running your app in a simulator, you can access the app’s console logs in the Console app (located in
/Applications/Utilities). When you run the app on a device, log entries from your app appear in the
Xcode Organizer.
To view a device’s console output:
1. Choose Window > Organizer to open the Organizer window.
2. Click Devices to display the devices organizer.
3. In the section for the device whose logs you want to view, select Device Logs.
The Device Logs pane in the Organizer contains information about app crashes. You may have to unplug your
device and plug it in again to refresh the crash list.
Formoreinformationabout crashlogs,see Understandingand AnalyzingiPhone OS Application CrashReports.
Troubleshooting: Debugging Issues
Xcode Displays the “Unknown iOS Detected” Dialog When You Plug In a Device
To successfully debug apps on the device, you must have Xcode collect the information it needs from the
device.
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206Tune the Performance of Your App
Optimizing your app’s performance is an important part of the development process. This optimization is
especially important in iOS-based devices, which, although powerful computing devices, do not have the
memory or CPU power that desktop or portable computers possess. You also have to pay attention to your
app’s battery use because it directly impacts the user’s battery-life experience.
This section introduces Instruments, the Xcode graphical tool that you use to measure and tune your app’s
performance.
For general performance guidelines, see "Performance Tuning".
The Instruments App
Withthe Instruments app, yougather a variety of appperformancemetrics, suchasmemory andnetwork use.
You can gather data from iOS apps running in a simulator or a development device.
It is important that your iOS apps use device resources as efficiently as possible to provide a satisfactory
experience for your customers. For example, your app should not use resources in a way that makes the app
feel sluggish to users or that drains their batteries too quickly. Apps that use too much memory run slowly.
Apps that rely on network access for their operation must use it as sparingly as possible because powering up
the radios for network communications is a significant drag on the battery.
The Instruments app provides an advanced data gathering interface that lets you know exactly how your app
uses resources, such as the CPU, memory, the file system, and so on.
Instruments uses software-baseddata-gatheringtools, known as instruments, to collectperformancedata. An
instrument collects a specific type of data, such as network activity or memory usage. A trace document
contains one or more instruments that collect data about an app.
Although most iOS apps can run in a simulator and you can test most design decisions there, a simulator
cannot completely match the behavior of a device. For example, it doesn’t replicate a device’s performance
characteristics such as CPU speed or memory throughput. To effectively measure your app’s performance on
user devices, you must use an actual device. Only on a device can you get an accurate representation of the
runtime environment (in terms of processor speed, memory limitations, specialized hardware requirements,
and the like).
Behavior you cannot test in a simulator and therefore must test on devices:
● Events involving more than two fingers.
● Actual accelerometer readings. Although you can access your computer’s accelerometer (if it has one)
through the UIKit framework, its readings differ from the accelerometer readings on a device. This
discrepancy stems largely from the difference in the positioning of the screen in relation to the rest of the
hardware between computers and iOS-based devices.
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207● Rendering by OpenGL ES. OpenGL ES uses renderers on devices that are slightly different from those it
usesinasimulator.Therefore,asceneinthesimulatorandthesamesceneonadevicemaynotbeidentical
at the pixel level. See “Drawing with OpenGL ES” in iOS App Programming Guide for details.
To measure your app’s performance on a device:
1. Buildandrunyour apponthedeviceasdescribedin"Simultaneously DesignandImplement User Interface
Objects Using Multiple Editors" (page 106).
2. Stop the app.
3. Launch Instruments.
The Instruments app is located at /Applications. ( refers to the installation location
of the Xcode toolset.)
4. Choose a template, such as Activity Monitor, to create the trace document.
5. From the Target toolbar menu, choose the device containing the app from which you want to collect
performance data.
6. Add or remove instruments from the trace document to collect the data you want.
7. From the Target toolbar menu, choose the app to launch (the same app you ran in step 1).
8. Click Record to start collecting data.
9. Use your app, exercising the areas you want to examine.
To learn more about measuring and analyzing app performance, see Instruments User Guide.
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208Xcode enables you to replace text strings throughout your project and to perform refactoring operations. A
refactoring operation—such as creating accessor methods for a symbol or creating a superclass from a
class—changes code without changing its behavior.
Replace Text Strings
You can use the search navigator to replace text strings throughout your project or workspace (Figure 9-1).
(To make syntax-aware changes to symbol names, including within nib files, use the Rename refactoring
operation instead.)
Figure 9-1 Search and replace using the search navigator
Thesearchandreplaceoperationcanbecustomized—forexample, tolimit thescopeof thesearchor tomatch
the case of letters in the string—and provides a preview that you can use to accept or reject individual
replacements.
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Make Projectwide ChangesNote: Thefirst timeyouperformamass-editingoperationsuchassearchandreplace,Xcodedisplays
a dialog giving you the option of first enabling automatic snapshots. You can change this setting
any time in the Snapshots pane of the File > Project Settings or File > Workspace Settings dialog.
You can use a snapshot to back out all of your changes at once if necessary.
If you don't have automatic snapshots enabled, you can make a manual snapshot of your project
before performing the operation by choosing File > Create Snapshot.
Replace All Instances of a Text String
The Replace command does pattern matching in text files and replaces instances of the search string with the
replacement text you specify.
To find and replace text in your project
1. Click the Find pop-up menu in the search navigator and choose Replace.
2. Type the text you want to find in the top text field and press Return.
Make Projectwide Changes
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210Note: Xcodedoesnotsearchfor the textuntil youpressReturn while the cursor isinthe search
field. The Preview and Replace buttons are not active until after you’ve performed the search
and one or more results are returned.
The Activity viewer in the workspace toolbar indicates when the find operation is in progress.
3. Type the replacement text in the lower text field.
4. Click Replace All to replace every occurrence of the Find text with the Replace text. To replace a single
result, click that result to select it and click Replace. To replace a subset of the occurrences found, use
Shift-click or Command-click to make your selection and click Replace.
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211Toseeapreview of thechangesbeforeproceeding, follow theprocedurein"ReplaceSelectedInstances
of a Text String" (page 212).
Replace Selected Instances of a Text String
See what your changes will look like in your source code before deciding which occurrences to replace by
using the search navigator’s preview feature.
To preview changes before replacing text
1. Click the Preview button below the Replace text field.
The preview dialog appears, showing the current version of each potential replacement in the right
column and the new version in the left column. Each arrow points at the version being used. All the
potential replacements are selected by default.
2. To change the status (from selected to deselected, or vice versa) of one or more replacements, do one
of the following:
● Click the checkbox for that change in the left pane of the dialog. Click the checkbox next to a
filename to change all the items in that file.
● Click the button in the center of the right pane for each item whose status you want to change.
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212● Use Shift-click or Command-click to select items in the list in the left pane, then press the Space
bar to change their status.
3. Click Replace to carry out the replacement of the selected items.
Customize the Search
The search navigator provides Find options to customize a search. For example, you can specify its scope and
whether the search should be case sensitive.
To specify a new scope for a search
1. In the search navigator, click the magnifying glass in the search field to open the Find options.
2. Open the “Find in” pop-up menu.
The default scope is the workspace. If you have more than one project in the workspace, your projects
are listed.
3. Choose Custom to create your own custom scopes.
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5. Use the pop-up menus to specify the scope.
Depending on your choices, you might also have to fill in or select a value for a third scope parameter.
6. Select the name of the scope and type a new name for the scope to appear in the “Find in” menu.
You can reopen this dialog and change the name at any time.
7. Repeat this procedure as many times as necessary to define all the custom scopes you want to use.
Click Done when you’re finished.
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Improve Your Code’s Structure Through Refactoring
A refactoring operation improves the structure of source code without changing its behavior. You refactor to
make the code easier to maintain, or as a first step in making further changes to the code.
Note: Refactoring works only with C and Objective-C files.
Select the Source Code to Refactor
Before you can choose a refactoring operation (also called a transformation) from the Refactor submenu in
the Edit menu or from the shortcut menu in the source editor, you have to select the symbol or source code
that you want to refactor. Only the refactoring operations appropriate for the selected text are available in the
menu. The descriptions of the refactoring operations at the end of this chapter specify what code to select for
each type of refactoring operation.
When you select the code andthe refactoring operation,Xcodepresents adialog to let you select options and
specify symbol names where necessary.
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215Preview the Changes Before Executing the Operation
Youhavetheopportunity topreview thechangesanddecide whichfilestoincludebeforeapplyingthechanges
by using the refactor preview dialog (Figure 9-2).
Figure 9-2 The refactor preview dialog
Deselect a file in the leftmost pane of the preview dialog to leave it out of the refactoring operation.
You can edit your source code directly in the preview dialog. Any such edits are shown in the preview and
included in the refactoring operation.
Before you’ve saved your updated files, you can use the Undo command in the Edit menu on a per-file basis
to back out changes.
Important: Bydefault, your changes aresavedautomatically whenyoucloseorbuildtheproject.Tochange
this behavior, open the General pane of Xcode preferences and set the Auto-save option to Ask or Never
Save.
Run Unit Tests Before and After Refactoring
As part of your refactoring workflow, you should develop unit tests for code you plan to refactor. Run these
tests before and after a refactoring to verify that the refactoring operation doesn’t change the behavior of the
modified code. For more information on unit tests, see "iOS Configuration" (page 75).
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216Choose a Refactoring Operation
The refactoring operations provided by Xcode include renaming a symbol, extracting a function or method
fromother code, encapsulatingaccessors for a symbol, creatinga superclass of a class,movinganitemupinto
a superclass, and moving an item down into one or more subclasses.
The Rename refactoring operation changes the name of the selected item throughout your project files.
To change the name of an item throughout your project
● Select any symbol except the declaration of a method inside a protocol interface, and choose Rename
from the Refactor submenu in the Edit menu (or from the shortcut menu in the source editor). (You
can rename such a method if the selection is a definition of such a method in a class that adopts the
protocol. That is, if the container of the selection is a protocol, you cannot rename it; if the container
of the selection is a class, you can.)
The Rename refactoring operation differs from the Find and Replace command in that Rename is
symbol- and context-aware. Find only matches strings. Rename is particularly useful with properties.
If you’re renaming a class and you have files that use that class in the filename, select the “Rename
related files” option to rename the files as part of the refactoring operation.
The Extract refactoring operation creates a function or method from selected code.
To extract a function or method
1. Select code or code and comments within a function or method implementation, and choose Extract
from the Refactor submenu in the Edit menu (or from the shortcut menu in the source editor).
Xcode analyzes the context of the selected code and the variables it uses to determine the generated
routine’s parameters and return value.
2. Inthedialogthat appears,name thenew routine anditsparameters, andselect whether it is amethod
or function.
The Encapsulate refactoring operation creates accessors (“get” and “set” methods) for a symbol and changes
code that directly accesses the item to use the accessor methods instead.
To create accessors for a symbol
● Select a symbol that is aninstance variable (ivar)or amemberof a structure, andchoose Encapsulate
from the Refactor submenu in the Edit menu (or from the shortcut menu in the source editor).
The Create Superclass refactoring operation creates a superclass from a class.
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1. Select a symbol that is a class defined in your project, and choose Create Superclass from the Refactor
submenu in the Edit menu (or from the shortcut menu in the source editor).
The Create Superclass refactoring operation creates skeletal interface and implementation statements
forasuperclassplacedintheinheritancehierarchybetweentheselectedclassanditsexistingsuperclass.
2. In the dialog that appears, name the new superclass and select whether to create new header and
implementation files for its interface and implementation statements or put them in the existing file.
The Move Up refactoring operation moves the declaration and definition of an item into the superclass of the
class where they currently reside, removing them from their former location.
To move the declaration and definition of an item into a superclass
1. Select a symbol that is a method or instance variable in a class, not a category, where the class and
superclass are defined in your project, and choose Move Up from the Refactor submenu in the Edit
menu (or from the shortcut menu in the source editor).
2. In the dialog that appears, select whether also to move methods that directly access the refactoring
item and that are defined in the same class as the refactoring item.
The Move Down refactoring operation moves the declaration and definition of the refactoring item to one or
more of the subclasses of the class that declares and defines the item.
To move the declaration and definition of an item into one or more subclasses
1. Select a symbol that is an instance variable in a class, not a category, where the class is defined in your
project and one or more subclasses already exist, and choose Move Down from the Refactor submenu
in the Edit menu (or from the shortcut menu in the source editor).
The Move Down refactoring operation moves the declaration and definition of the selected variable
into a subclass of the class where it currently resides, removing it from its former location.
2. In the dialog that appears, specify the subclass into which to move the variable declaration and
definition.
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218You manage iOS devices in Xcode using the Devices pane of the Organizer window (Figure 10-1).
Figure 10-1 Devices organizer
Althoughyoucandomuchof yourdebuggingandtestingof aniOSapplicationusingiOSSimulator,simulation
cannot completely match the results of running your application on the target devices; you must test your
application on actual devices to ensure that it runs as intended and to tune it for performance on actual
hardware.
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Manage Your DevicesNote: Before you can run your application on a device, you must first become a member of the iOS
DeveloperProgram.Seehttp://developer.apple.com/programs/iostolearnhow tobecomeamember.
Set Up Your Device
To use a device with Xcode, you must provide the device with a provisioning profile and install iOS on the
device.
Provision a Device
If you are a team administrator, or if your team administrator has already configured the necessary credentials
foryouandyourdevice,youcanusethedevicesorganizer toautomaticallydownloadandapplytheprovisioning
profile.
Provision your iOS device to run generic apps on your device, such as sample apps.
To provision a device automatically for development
1. Open the Devices organizer.
2. Connect your device to your Mac.
Manage YourDevices
Set Up YourDevice
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
2203. Select the device, and click “Use for Development.”
Developing apps requires a provisioned device. The provisioning process sets up the required certificates
and configuration data that Xcode needs to install your apps on your device. When you provision a device
forgenericdevelopment,Xcodeadds yourdevicetothegeneric teamprovisioningprofile.Thisprovisioning
profile allows development of most (but not all) types of apps. For some types of apps (such as those that
use push notifications or in-app purchases), you must use a manually configured provisioning profile.
Some types of applications require manual provisioning. In such cases, your team administrator must first
configure the necessary credentials for you, using the iOS Provisioning Portal. Follow your administrator’s
instructions to download the appropriate provisioning profile, and then use the devices organizer to locate
the provisioning profile on your file system and apply it.
Provision your device manually when you develop an app that requires a specialized provisioning profile.
Manage YourDevices
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221To provision a device manually for development
1. In the Devices organizer, select Provisioning Profiles in the Library section.
2. Click Refresh.
3. Identify the specialized provisioning profile you need to use.
4. Drag the provisioning profile to the Provisioning Profiles group of the target device.
Apps that supportpushnotificationsor in-apppurchases cannotuse thegeneric teamprovisioningprofile.
Instead, those types of apps must use a specialized provisioning profile, which you create in the iOS
Provisioning Portal.
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222Important: Before you can install a specialized provisioning profile on your device, that provisioning
profile must:
● Include your development certificate
● Identify your device
Note: All of the credentialing and provisioning procedures can be performed using the iOS
ProvisioningPortal, a restricted-access areaof the iOS Dev Center thatstoresinformationabout your
development devices. For details, see Tools Workflow Guide for iOS.
Restore or Install a Version of iOS on a Device
You should test your iOS application on devices running the version of iOS version targeted by the SDK you’re
using. The devices organizer enables you to restore a currently installed version of iOS or to install a new
version.
Install a new version of iOS when you want to upgrade a device for development.
To restore or install iOS on your development device
1. Select the device you want to update from the Devices organizer.
2. Select an iOS version from the Software Version pop-up menu.
3. Click the Restore button, and confirm you want to install the software.
4. When installation is complete, activate the device and restore its contents using iTunes.
5. Back in Xcode, click “Use for Development” in the Devices organizer to reenable development for the
device.
See the HTML version of this 
document to view the video. document to view the video.
You may need to install iOS on your development device to run your app on a beta or GM version of the
iOS software.
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223The Software Version pop-up menu displays the versions of iOS that are available for you to install. If the
versionyou want isnot listed, youmust addit tothismenubeforeyoucaninstall it. Toaddthenew software
version to the menu, select Other Version and navigate to the software image on your computer. Xcode
then adds the version to the pop-up menu and makes it available for installation.
Whenyouenableadevicefordevelopment,Xcodeinstallsanyprovisioningprofilesanddevelopment-related
data associated with the device. Xcode asks you for your developer program credentials and provisions
any new devices automatically before making them available for development.
Important: The version of iOS you install must be the same as or newer than the version currently
installed on the device. Attempting to install an older software image will fail. After a failed installation
attempt, you must reinstall the last successfully installed version or a newer version of iOS.
Note: You can download seed releases of the iOS SDK and iOS, when they are available, from the
iOS Dev Center.
Run Your Application On a Device
Set the run destination to iOS device in the scheme editor and build and run your application. Xcode transfers
the application to the device and executes it.
Remove an Application from a Device
Successful development and testing frequently depend on starting with a clean execution environment. To
achieve this state, you can completely remove your application from a device.
Delete an app from your device to remove all data files associated with the app.
To remove your application from a device
1. In the Devices organizer, select Applications in the device.
2. Select an app from the list of installed apps.
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2243. Click Delete, and confirm that you want to remove the app.
During development, you might remove an app in order to test code that runs only when your app is first
launched.
FromXcode, youcanremoveonly theappsthat youcreated.Youcannot removeanyof thesystem-installed
or third-party apps from the device using Xcode.
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225Alternative: Another way to remove a third-party app (including your own) from a device is to
touch and hold the app icon on the device until the icons start wiggling. Then tap the close box
on a given app to remove it from the device. When you are done, press the Home button.
Download Your Application’s Data for Analysis
You probably have favorite tools that you use in inspecting application-generated data. To use such tools, you
need to copy that data to your computer intact. To do so, you download the data from the devices organizer,
specifying a location for the data on your local file system.
Copy an app’s data from its sandbox on an iOS device to your file system to examine or modify the data.
To download your application’s data from a device
1. In the Devices organizer, select Applications in the device.
2. Select the app.
3. Click Download.
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227When you copy the app data, the app itself is not copied, and neither is any data the app stores in the
keychain.
Analyzing the contents of an app’s sandbox may provide important information to help you diagnose
problemsor tune the app. Youcanexamine files that the appcreated—or that itobtainedfromanexternal
source—to find out whether the files contain valid information or indicate a problem.
Capture and Use Screenshots from a Device
Screenshots are important in several aspects of development and distribution—for example, serving as
illustrations in documentation and as graphics for the App Store and other marketing needs.
In the organizer you can capture and manipulate screenshots of your application running on the device.
Capture a screenshot on your device to document your progress during development, and create launch
images for your iOS apps.
To capture screenshots from a device
1. On the device, configure the screen the way you want it.
2. In the Devices organizer, select Screenshots in the device.
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When generating your app’s default images, you should always capture images from devices with the
appropriate screen size and resolution. For a universal app, this means capturing screenshots both from
aniPadandfromaniPhoneor iPodtouch. For anappthat alsosupportsRetinadisplays, itmeans capturing
screenshots from an iPhone 4 in addition to any other devices.
Set a Screenshot as Your iOS Application’s Launch Image
An application launch image, or default image, enhances the user’s experience at application launch. When
the user starts your application, iOS immediately displays this image. Your application then displays its first
screen as soon as possible, replacing the launch image.
Set the launch image of your app to give the user immediate feedback that the app launched.
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229To set a screenshot as your iOS application's default image
1. In the Devices organizer, select Screenshots for a device or for the Library section.
2. Select an image.
3. Click “Save as Launch Image.”
4. Specify the name of the image and the target app, and click Next.
A launch image acts as a placeholder for your app’s user interface at launch time. When the user launches
your app, the iOS presents this image until your app displays its main window and starts responding to
events.
An iPhone app has only one launch image, typically named Default.png. An iPad app can have multiple
launchimages, eachonepresentingthe app’suser interface ina specificdeviceorientation. Launchimages
may have names other than Default.png.
Manage YourDevices
Capture and Use Screenshots from aDevice
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
230To help avoid a jarring experience when this switch occurs, the ideal default image looks identical to the first
screen your application displays, except that it should omit any UI elements that could change.
Export a Screenshot to Your File System
To use a screenshot outside your application, for example, in documentation or marketing materials, you can
export it from within the devices organizer.
Save a screenshot to your file system to archive it or use it for materials related to your app.
To export a screenshot to your file system
1. In the Devices organizer, select the appropriate Screenshots group.
2. Select the screenshot, and click Export.
3. When prompted, enter a name and location for the screenshot, and click Save.
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231You may want to provide one or more screenshots of your app when submitting it for publication on the
App Store.
Saved screenshots are exported as high-quality PNG files.
With the screenshot file on your computer file system, you can modify it with any graphics editing application
that accepts PNG files.
Identify Small UI Changes by Comparing Screenshots
Asdevelopmentprogresses,small changes youhavemadetoyour UImaybeunrecordedandremainunnoticed
until late in the development cycle. To help mitigate this problem, you can compare different versions of a
screenshot to determine exactly what has changed.
Compare screenshots to detect subtle changes to your user interface.
To compare screenshots
1. In the Devices organizer, select the appropriate Screenshots group.
2. Select two or more screenshots.
3. Select the Compare option.
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2324. Use the Tolerance slider to adjust the comparison threshold.
The screenshots you select must be the same size and at least somewhat similar. You cannot compare
screenshots whose resolution or dimensions are different. For example, you cannot compare a screenshot
taken on a Retina display with one taken on a lower-resolution display. If the content of the screenshots is
completely different, the Compare option is not available.
Transfer Your Developer Profile to Another Computer
Yourdeveloperprofileis yourofficialdigital identificationfor iOSapplicationdevelopment. If yourdevelopment
workflow requires you to use another user account or another computer, you must copy that profile to that
other account or computer.
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233To do so, you first export your profile, which archives the profile into a password-protected secure file in a
location that you specify on your operating system. This export is performed in the devices organizer.
Archive your code signing assets to keep them safe or to use them on another Mac.
To export your developer profile
1. In the Devices organizer, select your team in the Teams section.
2. Click Export.
3. Specify a filename and a password, and click Save.
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234The file produced contains the items you need to code sign apps, including the provisioning profiles,
certificates, and private keys needed to install apps in development on a device.
Because it contains sensitive information that can be used to sign apps in your name, the contents of the
file are stored in an encrypted format using the password you provide. That password is required later to
import the file to another system.
Next, you copy the archive file to the other account or computer.
Finally, in the other account or on the other computer, you use the devices organizer to import your profile
by extracting it from the archive file.
Place your code signing assets on a new Mac by importing the code signing assets exported from another
Mac.
To import your developer profile
1. In the Devices organizer, select your team in the Teams section.
2. Click Import.
3. Select the file containing your code signing assets.
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The importation process installs the certificates, private keys, and provisioning profiles that are stored in
the developer-profile file.
Troubleshooting: If you don’t see the Team section in the devices organizer:
● Drag the password-protected file that contains your code signing assets to the Xcode icon
in the Dock.
Manage YourDevices
Transfer YourDeveloper Profile to Another Computer
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
236Finally, in the other account or on the other computer, you use the devices organizer to import your profile
by extracting it from the archive file.
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237As youcreate your app,Xcode automatically saves changes tosource,project, and workspace files. This feature
simplifies workflow, helps keep you from losing any of your work, and requires no configuration.
When creating an app, sometimes you may want to experiment with a new user interface layout and then
revert to the previous one. Or you may need to undo some code that you’ve just written because you found
an error orproblem. These circumstances require that you understand how Xcode saves your work to disk and
know how to revert your work to a prior state.
This chapter explains how Xcode automatically saves your work and shows how to use the Revert Document
and Undo commands. The Snapshot feature is introduced as well as Xcode’s built-in interface to source code
management so that you understand how they relate to the overall tasks of change management in your
development projects.
Save when Editing
As youedit,Xcodecontinuously tracks changesandsavesthem,but itdoesnot continuously writethechanges
to disk. They are saved in memory as you work. Xcode then automatically writes your changes to disk when
one of five operations is performed:
● You build and run your app.
● A snapshot is created.
● You commit files to an SCM repository.
● You close the project.
● You quit Xcode
You can also save changes to disk manually using the Save command in the File menu.
Revert to the Last Saved Version
To discard all changes you’ve made to a file since it was last saved, use the Revert Document command in the
File menu. After a confirmation dialog appears, click the Revert button to complete the operation.
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Save and Revert Changes to FilesThe Revert Document command is available only when the contents of a file have been changed since it was
last saved to disk. Files with in-memory changes are indicated in two places: The file icon is highlighted in the
project navigator and in the associated editor pane’s jump bar. Highlighted icons in the project navigator let
you see which files have in-memory changes throughout the entireproject. The highlightedicon in an editor’s
jump bar indicates whether any changes to the document currently in view were made since it was last saved.
For example, in Figure 11-1 you see a workspace window with the file MainMenu.xib open in the primary
editor and three text files (Controller.h, Controller.m, and ReadMe.txt) open in assistant editors.
Figure 11-1 Workspace window with in-memory changes to files
Open with changes
Threeof thefour filesopeninFigure11-1havechangedsincethey werelastsaved, indicatedby thehighlighted
icons in the jump bars and in the project navigator. The Revert Document command allows you to revert to
the last savedversionof eachfile, one at a time. It acts onthe file that currentlyhas the editingfocus, obtained
by clickinginits editorpaneorby clickingitsname intheprojectnavigator. Inthisillustration,MainMenu.xib
has the editing focus, which you can tell by the slightly darker coloring of the jump bar in the primary editor.
Using Revert Document in Xcode always returns the contents of the file to the last saved version on disk. If
you are not sure when the file was last saved to disk relative to when you made changes, or you would prefer
to back out changes one at a time, use the Undo command in the Edit menu.
Save and Revert Changes to Files
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239Undo Changes Incrementally
To back out changes to a file incrementally, use the Undo command in the Edit menu, shown in Figure 11-2.
Figure 11-2 Undo Typing command
Note: The Undocommandis contextsensitivetothelasteditingoperationperformed. Forexample,
the command changes from Undo to Undo Typing or to Undo Add Menu Item depending on the
context of the last operation performed.
After you’ve chosen the Undo command, the Redo command becomes available to reverse the last
undo operation.
The Undo command in Xcode allows you to incrementally back out all changes to a file since the start of an
editing session. An editing session begins when you open a project with Xcode and ends when you close the
project. When you work on a file in a single session, Xcode lets you undo all the edits in that session, even
those already saved to disk.
Whenyou work ina textdocument andchoose Undo, the source editor sets the insertionpoint tothe affected
sectionof thetext andbringsthatsectionintoview. Inthis way, youknow thechangethat the Undocommand
has undone.
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240Note: Using the Revert Document command clears the Undo history; you cannot undo a revert
operation.
Unlocking Files
Files included in a project may be locked for several reasons. For example, they may be header files included
in system frameworks, or they may havebeen intentionally locked in the Finder toprevent accidental deletion
and renaming. Locked files cannot be edited; they are available only for reading, searching, and selecting
portions to copy.
If you attempt to edit the contents of a locked file, Xcode presents a notification asking whether you want to
unlock the file. Click the Unlock button to continue the unlocking operation. If the file cannot be unlocked,
you receive another notification (see, for example, Figure 11-3).
Figure 11-3 File could not be unlocked
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241Locked files are indicated in the Xcode workspace by a locked file icon in the project navigator or by a lock
icon in the associated editor pane’s jump bar. The locked file icon also appears in the workspace window title
when the document is in the primary editor pane (see Figure 11-4).
Figure 11-4 Locked file indicators
Locked file icon Locked file icon Lock icon
Note: The lockedfile iconappearsintheprojectnavigatoronly for filesthat are lockedinthe Finder.
Files locked for write access due to ownership permissions or read-only media show the lock icon
in the jump bar.
When you start editing a locked file, Xcode asks whether you want to unlock it. You can also unlock a file by
using the Unlock command in the File menu or by clicking on the lock icon in the jump bar of its associated
editor pane.
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242Use Snapshots and SCM for Projectwide Change
When you develop a project, you often make changes on a larger scale than changes to individual files. The
snapshot and source code management systems provide save and revert facilities that operate project wide.
Snapshots Archive Projectwide Changes to Documents and Configuration
Use the Create Snapshot command in the File menu to create an archive of the project or workspace.
You can make three types of projectwide changes for which the Revert Document and Undo commands are
not supported:
● Xcode projectwide operations, which involve changes to many document files and potentially to project
settings. These operations include refactoring code, adding Automatic Reference Counting to an existing
project, and performing project validation.
● Adjustmentstothe workspaceandprojectsettings.Xcodesavesthesechangestodiskastheyareperformed
by modifying the .xcodeproj and .xcworkspace files.
● Your global editing operations using search and replace functions.
Snapshots are archives that include the current state of all project and workspace settings and all document
files included in the project context. All document files are saved when a snapshot is created. Xcode always
stores snapshots in your local file system.
Creating a snapshot before making changes to project settings, and before using global search and replace,
gives you the ability to revert the entire project to the state it was in before you performed a projectwide
operation.
Note: Xcodeautomaticallycreatesasnapshotof theprojectbeforeperformingrefactoring,automatic
reference counting conversion, and validation.
For more information about snapshots, see "Save and Revert Changes to Projects" (page 245).
SCM Repositories Manage Overall Change as Your Project Develops
The Source Control commands in the File menu allow you to manage your project files with a source code
management (SCM) repository.
Automatic save, revert, undo, and snapshots are intended to help the flow of editing and making adjustments
as you develop your project with respect to the document files it includes. These features are not intended to
be the way you manage overall project change through the development history of a project. To support this
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management commands that allow you to use both locally stored and server-based SCM repositories. Using
an SCM repository is strongly recommended even for small development projects.
Formore informationabout usingsource codemanagement, see "Save andRevert Changes to Projects" (page
245).
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● A snapshot saves the current state of your project or workspace on disk for possible restoration later.
● Source control repositories keep track of individual changes to files and enable you to merge different
versions of a file.
● An archive packages your products for distribution, either through your own distribution mechanism or
for submission to the App Store.
Xcode provides direct support for Git and Subversion repositories, including an option to create a local Git
repository when you create a new project. Because it’s so easy to set up a repository to use with your Xcode
project, Xcode provides a special editor, called the version editor, that also makes it easy to compare different
versions of files saved in repositories.
This chapter assumes that some developers using Xcode are new to repositories. If you’re an experienced
repositoryuser,skipover theintroductorymaterial ineachsectionandgostraight tothedescriptionsof aspects
of Xcode’s repository UI.
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Save and Revert Changes to ProjectsTake a Snapshot of Your Project
A snapshot provides an easy way to back up the current version of your project or workspace so that, if
something goes wrong with a change or process, you can restore the earlier version. Xcode can create a
snapshot automatically before a major change such as refactoring your code or executing a Find and Replace
operation. You can change this setting any time in the Snapshots pane of the File > Project Settings or File >
Workspace Settings dialog (Figure 12-1).
Figure 12-1 The Snapshots settings dialog
You can also set Xcode to automatically create snapshots in other circumstances, such as before a build, by
selecting the Create Snapshot option in the Behaviors pane of Xcode preferences ("Customize Your Build and
Run Workflow" (page 155)).
You can create a snapshot manually whenever you like by choosing File > Create Snapshot. To see where
Xcode stores your snapshots, or to change the location, look in the Locations pane of Xcode preferences or
the Snapshots pane of the Project (or Workspace) Settings dialog.
Important: To use snapshots, you must have selected System Tools in the Xcode installer. This option is
selected by default.
To see the snapshots for a project or workspace, click the project in the projects organizer. To restore from a
snapshot in Xcode 4.0, select a snapshot in the projects organizer and click the Restore Snapshot button at
the bottom of the window.
In Xcode 4.1 and later, to restore a snapshot, choose Restore Snapshot from the File menu and select the
snapshot to restore. Xcode displays a preview dialog in which you can review the differences between the
current version of the project and the snapshot version. When you click Restore, Xcode replaces the current
version of the project with the version in the snapshot. Xcode makes a snapshot of the current version before
replacing it.
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the Projects pane of the Organizer window, choose the snapshot you want to restore, and click the Export
Snapshot button at the bottom of the window (Figure 12-2).
Figure 12-2 Snapshots listed in the Organizer window
Because Xcode 4 keeps track of all your projects and displays them in the projects organizer even if they no
longer exist, you can restore a deleted project from a snapshot.
Keep Track of Changes with Source Control
When working on a software project, it can be very useful to use software control management (SCM) to keep
track of changes in the code and coordinate work groups. An SCM system, also referred to as source control,
savesmultipleversionsofeachfileondisk,storingmetadata abouteachversionofeachfileina locationknown
as an SCM repository.
Why Use Source Control?
There are two fundamental reasons for using source control:
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247● A source control system helps you reconstruct past versions of the software and the process used to
develop it. If you are working on a project by yourself, you can commit a file to your SCM repository each
timeyoumakeamajor change.Then,ifyoufindyou’veintroducedbugs,youcancomparethenew version
with a past version that worked correctly to help to locate the source of the trouble. In the worst-case
scenario, you can revert to an earlier version and start over from there to reimplement the new feature. If
you keep your repository, or a copy of the repository, in another, physically safe location, you can even
reconstruct your project if your computer is lost or destroyed.
● When two or more people are working on the same project, source control helps prevent conflicts and
helps resolve conflicts should they arise. By keeping a central repository that holds the canonical copy of
the software, the source control system allows each programmer to work on his or her own local copy
without anydangerof corruptingthe canonical version. If yousetupa systemof checkingout a filebefore
working on it, you can ensure that two people are not working on the same code at the same time. If two
people do change the same code, the SCM software helps you to merge the two versions. You can also
look through past changes to see what they were and who made them, which can be a great help in
managing the project and in fixing bugs.
Choose Git or Subversion
XcodesupportstwoSCM systems:Subversion(oftenabbreviatedsvn)and Git.Subversionisalwaysserver-based
and the server is normally on a remote machine, though it is possible to install one locally. Git can be used
purely as a local repository, or you can install a Git server on a remote machine to share files among team
members. The Xcode 4 installer installs the Git and Subversion tools when you select System Tools.
If you are working alone, it’s generally easiest to use Git, as you don’t need to set up a server. In fact, Xcode
can automatically set up a Git repository for you when you create a new project (see "Create a Git Repository
For Your New Project" (page 60)). For a group project, the choice of Subversion or Git is usually a matter of
taste and prior experience.
In so far as is possible, Xcode provides a consistent user interface and workflow for users of either Subversion
or Git.
Learn SCM Terminology
In general, you work on a copy of the project (called, appropriately, a working copy). The command to create
a working copy is clone for Git and checkout for Subversion. When you have changed one or more files and
want to add your changes to the repository, you execute a commit command to the SCM software. The SCM
software records the date and time of the commit, any comments you include to help you remember later
why you committed this version of the code, your identity (that is, the identity of the person who executed
the commit command), and any other information the SCM software needs in order to keep track of the
software.
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sends those changes back to the server. Because Git repositories can be local or on a server, the situation is a
bit different with Git. For Git, your working copy is also a local repository, so once you’ve committed the file,
the repository has been updated. Even if you have a remote Git server, committing a file in Git does not
automatically send changes to the server. To update the Git repository on a remote server, you use a push
command.
Toupdate your workingcopy withthe latest versionof the file ina remote repository, youuse a pull command
(in Git) or update command (in Subversion). For a local Git repository, the pull command is not needed.
The main line of code for development is often referred to as the trunk. To avoid modifying the trunk while
developingnew features, youcancreateanew copyof theproject referredtoas abranch.Eventually,branches
aremergedback intothe trunk. In Git, abranchissimply a workingcopyof theproject. InSubversion, abranch
is a copy maintained by the repository. You can check out any number of working copies of a Subversion
branch. When you update your local working copy with the update or pull command, and when you merge
two branches or merge a branch into the trunk, Xcode displays a dialog that lets you reconcile differences
between the versions. You can also use the version editor to compare two versions of a file at any time.
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In Xcode, you configure SCM repositories in the Organizer (Figure 12-3).
Figure 12-3 The repositories pane in the Organizer window
The repositories pane of the Organizer window (referred to hereafter as the repositories organizer) lets you
examine the structure of the repository (folders, files, and branches) and your working copy. In addition to the
more obvious features provided by the repositories organizer, it lets you assign address-book information to
theperson who committedeachversionlistedandyou canexamine the changes to eachfile for eachcommit.
To assign address book information to identities in the organizer
1. Click a repository in the navigation pane of the repositories organizer.
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3. Fill in the information about the person who executed the commit, or if the person is in your address
book, click Choose Card and select that person’s card in your address book. If your address book has
a picture associated with the entry, the picture is displayed in the organizer.
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To view changes for a specific commit version
1. In the navigation pane of the repositories organizer, select the working copy folder of the project.
2. Click the disclosure triangle next to the commit ID number.
3. Click View Changes.
4. Select a file in the navigation pane.
5. Scroll, if necessary, to view changes in the file.
See the HTML version of this 
document to view the video. document to view the video.
Clicking the disclosure triangle for a commit version reveals a list of changed files, allowing you to quickly
scan for the one you want to inspect.
In the inspection dialog, Xcode displays the changes between the file you have chosen and the previous
commit of the same file. For convenience, each change is highlighted in the editor pane and indicated by
a red mark in the scroll bar.
The video shows viewing changes in the SKTLine.h file in the most recent commit version of the
Skecth_git_M repository.
Find SCM Commands
SCM commands are located in the main Xcode menu, in the shortcut menu, and in the repositories organizer.
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Figure 12-4 The Source Control submenu of the File menu
The project navigator shortcut menu contains a subset of these commands (Figure 12-5).
Figure 12-5 The Source Control submenu of the project navigator shortcut menu
Many SCM commands can be executed by using buttons at the bottom of the repositories organizer. Which
buttons are available andactivedepends onyour selectioninthenavigatorpane of the repositories organizer.
For example, Figure 12-6 shows the buttons at the bottom of the repositories organizer when a git working
copy is selected.
Figure 12-6 Repositories organizer buttons
Update and commit operations are recorded in the log navigator. Select a log to see the individual steps of
that operation in the log viewer.
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You can keep track of your files’ SCM status in the project navigator. SCM status is shown as a badge next to
the file name (Figure 12-7), as follows:
Badge SCM status
Locally modified M
Updated in repository
U
Locally added A
Locally deleted D
Ignored I
Replaced in the repository
R
The contents of the folder have mixed status; display the contents to see individual status –
Not under source control ?
Figure 12-7 Source control badges in the project navigator
Badgespropagateuptothehighest containersoyoucansee the source controlstatusof the whole workspace
regardless of the disclosure level. Detailed SCM status is shown in the Source Control area of the File inspector
in the utility pane.
Save and Revert Changes to Projects
Keep Track of Changes with Source Control
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
254Work with Git and Subversion
Common source control tasks include setting up a repository, checking files out of and in to a repository,
reconciling different versions of a file, and using branches to isolate risky changes to your code.
Set Up Git Version Control When You Create a New Project
As described in "Create a Git Repository For Your New Project" (page 60), Xcode creates a Git repository for a
new project if youselect theSource ControloptionintheSave Asdialog.Whenyoudoso,Xcodeadds ahidden
file (named .git) to the folder containing the project. That file contains all the information Git needs to keep
track of the files in the project and the changes made to them. Xcode also performs an initial commit of the
files in the folder. Any time you add files to your project or modify any of the files in the project, you need to
commit them to add them to the repository (see "Commit Files to Add Them to a Repository" (page 265)).
Add Git or Subversion Version Control to an Existing Project
You may need to create your own repository if, for example, you want to start managing an existing project
under source control. You can use command-line tools to set up a Git or Subversion repository. The necessary
tools are installed during Xcode installation, if you select the System Tools package.
Use command-line commands to set up a Git repository for an existing project.
To set up a Git repository from the command line
1. Use the cd command to switch to your project directory, making it the current working directory.
2. Enter git init to create an empty repository.
3. Enter git add . to copy your project files into the repository.
4. Enter git commit -m "Initial commit" to commit all the files.
// Step 1
$ cd /Users/me/sample_code/Sketch
// Step 2
$ git init
Initialized empty Git repository in /Users/me/sample_code/Sketch/.git/
// Step 3
$ git add .
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$ git commit -m "Initial commit"
[master (root-commit) 173067e] Initial commit
...
74 files changed, 10198 insertions(+)
create mode 100644 .DS_Store
create mode 100644 Arrow.tiff
create mode 100644 Circle.tiff
create mode 100644 Cross.tiff
create mode 100644 Draw2App.icns
create mode 100644 Draw2File.icns
create mode 100644 English.lproj/Draw2.nib/classes.nib
...
create mode 100644
Sketch.xcodeproj/xcuserdata/ernest.xcuserdatad/xcdebugger/Breakpoints.xcbkptlist
create mode 100644
Sketch.xcodeproj/xcuserdata/ernest.xcuserdatad/xcschemes/Sketch.xcscheme
create mode 100644
Sketch.xcodeproj/xcuserdata/ernest.xcuserdatad/xcschemes/xcschememanagement.plist
create mode 100644 TextGraphic.tiff
To set up a repository for an existing project, you have to use the command-line shell implemented by the
Terminal utility app.
Use command-line commands to set up a Subversion repository.
To set up a Subversion repository from the command line
1. Use the mkdir command to create a directory with three subdirectories named branches, tags, and
trunk to hold a temporary copy of your project.
2. Copy the project directory into the trunk subdirectory.
3. Create a directory for the Subversion repository.
4. Use the svnadmin create command to create an empty Subversion repository.
5. Use the svn import command to import your project directory into the new Subversion repository.
// Step 1
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256$ mkdir /Sketch_svn_tmp
$ mkdir /Sketch_svn_tmp/trunk
$ mkdir /Sketch_svn_tmp/branches
$ mkdir /Sketch_svn_tmp/tags
// Step 2
$ cp -R /Users/me/sample_code/Sketch /Sketch_svn_tmp/trunk
// Step 3
$ mkdir /svn_rep
// Step 4
$ svnadmin create /svn_rep/Sketch_svn
// Step 5
$ svn import /Sketch_svn_tmp file:///svn_rep/Sketch_svn -m "Initial import"
Adding /Sketch_svn_tmp/trunk
Adding /Sketch_svn_tmp/trunk/Sketch
Adding /Sketch_svn_tmp/trunk/Sketch/SKTGraphicView.h
Adding (bin) /Sketch_svn_tmp/trunk/Sketch/Cross.tiff
Adding /Sketch_svn_tmp/trunk/Sketch/SKTAppDelegate.h
...
Adding /Sketch_svn_tmp/trunk/Sketch/NSColor_SKTScripting.m
Adding /Sketch_svn_tmp/branches
Adding /Sketch_svn_tmp/tags
Committed revision 1.
To set up a Subversion repository, you have to use the command-line shell implemented by the Terminal
utility app.
If you don’t have an existing project, use Xcode to create a project before setting up your repository.
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257Note: By convention, a Subversion repository contains three additional subdirectories named
branches, tags, and trunk.
Clone or Check Out a Copy of a Project to Use Locally
If you or your work group have a Subversion server or a master copy of a Git repository shared on a file server,
you can create a local working copy by checking out (Subversion) or cloning (Git) a copy of the master. You
can then use the source control commands in Xcode to commit changes to your local copy, update your local
copy fromthemaster copy, andpushyour changesuptothemaster copy (for Git). Note that it isnotnecessary
to clone a copy of a local Git repository, as in this case the master copy is also your working copy.
Check out or clone a repository to create a copy on your local system.
To check out or clone a repository
1. In the repositories organizer, click the Add button and choose Checkout or Clone Repository.
2. Enter the pathname or URL for the file.
3. When the “Host is reachable” indicator turns green, click the Next button.
4. Enter a local name for the repository and click Clone (or Checkout) to copy it.
5. Choose a location and click the highlighted Clone (or Checkout) button to save the local repository.
See the HTML version of this 
document to view the video. document to view the video.
By abstracting common repository operations, Xcode supports both Git and Subversion (SVN) repositories
with a single, unified graphical user interface and workflow. Depending on your choice, this one operation
checks out (for SVN) or clones (for Git) the repository and integrates it with your project.
Cloning a Git repository in Xcode sets up a complete repository on your local system and integrates that
repository with your workspace so that you can quickly start using it. This approach gives you the benefits
of distributed version control, including full commit rights, whether you’re online or not.
An SVN checkout operation does not create a local repository. You must have a network connection to the
repository server to be able to commit changes.
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258For SVN, you must also provide the relative paths to the trunk, branches, and tags directories. To do
so, click the name of the new repository in the repositories organizer and fill in the associated fields. If your
SVN server requires authentication, fill in the user name and password as well.
The video shows cloning a Git repository for the Sketch sample code project.
Add an Existing SCM Working Copy of a Project to Xcode
If you have a working copy of a project that was checked out of Subversion or cloned from Git using the
command line or another tool, you can add it to your Xcode SCM repository support. To do so, click the Add
button (+) at the bottom of the navigation pane in the repository organizer and choose Add Working Copy.
Create a Branch to Isolate Risky Changes
After you’ve been working on a project for a while, you are likely to have a body of reliable, stable code.
Althougharepositoryenablesyoutorevert toanearlierversionifyoudestabilizeyourprogramwhileattempting
to adda new feature, youmight want tobe able to work on the new feature while stillmaintainingyour stable
bodyof code. That way,oneof themembersof your teamcan(for example) workonrefiningtheuser interface
or fixing minor bugs while another team member works on a risky new feature. In order to implement such a
scheme, most source control systems (including Git and Subversion) allow you to create a branch, which is
another copy of your code that you can modify independently of the original body of code (or of any other
branches). You can base a branch on the trunk or on any other branch.
Subversion keeps all the information about branches, submissions, updates, and so forth on the server. You
needtobe connectedtothe server tosee anyof this informationinXcode. In Git, whenyouclone a repository,
youget a copyof allof themetadata associated withtherepository as well as copiesof all theexistingbranches.
To see the structure of a Subversion repository without checking out a working copy, or to see the branches
of a remote Git repository soyoucancloneanindividualbranch,usethe AddRepositorymenuitem(see"Clone
a Specific Branch" (page 262)).
Create a branch in a repository to isolate specific aspects of your software development efforts and to work in
parallel with other developers.
To create a branch in a Git repository
1. In the repositories organizer, select the appropriate Branches directory in the navigator pane and click
the Add Branch button.
2. Enter a name for the new branch.
3. From the pop-up menu, choose an existing branch to serve as the starting point for this new branch.
4. If appropriate, select the option to automatically switch to the new branch.
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2595. Click Create.
Git creates the new branch in your local repository. To make the branch available to others on a remote
Git repository, you need to use the Push command.
The illustration shows adding a branch named Third, using the branch named Second as a starting point.
Important: Consistent branching practices are critical to successful source control management. Be
sure to understand and adhere to your organization’s branching strategy.
Create a branch in a repository to isolate specific aspects of your software development efforts and to work in
parallel with other developers.
To create a branch in a Subversion repository
1. In the repositories organizer, select the appropriate Branches directory in the navigator pane and click
the Add Branch button.
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3. From the pop-up menu, choose an existing branch to serve as the starting point for this new branch.
4. Enter a log message if you wish.
5. If appropriate, select the option to automatically check out the new branch.
6. Click Create.
Subversion creates the new branch in the remote repository; to work on it locally, you must first check it
out. Selecting the “Automatically checkout this branch” option causes Xcode to check it out for you. If you
select this option, Xcode opens a Save As dialog so you can specify the name and location for the working
copy of the new branch. If you do not select this option, you have to check out the branch before you can
work with it.
The illustration shows adding a branch named Sixth, using the branch named Fifth as a starting point.
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261Important: Consistent branching practices are critical to successful source control management. Be
sure to understand and adhere to your organization’s branching strategy.
Switch to another branch of a repository to work on a different line of code development or to prepare for a
branch merge.
To switch branches
1. In the navigation pane of the repositories organizer, click the working copy folder for the repository.
2. Click the Switch Branch button at the bottom of the Organizer window.
3. In the Select a Branch dialog, choose the branch you want to use from the pop-up menu.
4. Click OK to confirm the switch.
See the HTML version of this 
document to view the video. document to view the video.
Whenthe workingcopyof abranchisselectedinthenavigationpane, thenameandlocationof thecurrent
branchdisplay at thetopof theorganizerpane.Whentheswitchingoperationissuccessful, thisdesignation
updates to reflect the new current branch.
The video shows switching from the Henchley_01 branch to the Cardiff_02 branch of the Sketch
svn_M repository.
Clone a Specific Branch
Rather than clone an entire remote repository, you might want to clone only a specific branch. Use the Add
Repository command for thispurpose. You can also use the Add Repository command tobrowse a Subversion
repository without creating a working copy.
To clone specific branches of a remote repository
1. Open the repositories organizer, click the Add button (+) at the bottom of the navigator pane, and
choose Add Repository.
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repository. Click Add.
3. Select the branch for which you want a local working copy and click Clone.
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263Add a Folder to a Subversion Repository
When you select a folder such as Trunk for a Subversion repository in the navigation pane of the repositories
organizer, or any folder in the outline view of a Subversion repository, a New Directory button is available at
the bottom of the window. This button creates a new directory, represented as a folder in the organizer. If no
folder isselectedintheoutlineview, thefolder is createdat thesamelevel asthetop-level foldersintheoutline
view. If a folder in the outline view is selected, the new folder is created inside that folder.
Tip: Xcodeprovidesthe NewDirectorybuttonintherepositoriesorganizer tohelpyouadministeryourSubversion
directory. It’snot intendedformodifyingyourXcodeproject. Toadda folder toaproject,use theprojectnavigator
in the workspace window.
Once you create a new Subversion directory, you can add files to it.
Add nonproject files to a repository folder created with the repositories organizer.
To add files to a new Subversion directory
1. In the repositories organizer, select the folder to which the files will be added.
2. Click the Import button at the lower right corner of the window.
3. Locate and select the desired file or folder.
4. Click Import.
5. Enter a commit message and click Import.
See the HTML version of this 
document to view the video. document to view the video.
The repositories organizer supports creating a folder in a subversion repository for maintaining and
administering the repository. For example, you might want to include documents that provide details for
a specific branch or that specify any deviations from your organization’s branching and merging protocols.
To add folders and files to a project, use the project navigator in the workspace window.
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264Alternative: You can drag files to the folder from the Finder. If you use this approach, an Import
dialog appears in which you can add an import message and confirm the operation.
The video shows adding the file Branching_conventions_and_protocols.txt to the Admin_Docs
Subversion directory.
Commit Files to Add Them to a Repository
When you edit a file, it is changed locally but the changes are not included in the source control repository.
To add the changes to the repository, you must commit the file. You must save the file before you can commit
it, but note that saving a file is not the same as committing it to source control—you must explicitly commit
the file. To see which files have been modified locally but not committed, look for the M badge next to the
filename in the project navigator. (New files that have never been committed to source control have the A
badge. Files that are not under source control have a question mark badge.) You can use the SCM status filter
at the bottom of the project navigator to display only files with SCM status.
Commit changed files to ensure that those changes are preserved and managed as part of a repository.
To commit files to a repository
1. Ensure that you have saved all file changes.
2. Choose File > Source Control > Commit.
3. In the confirmation dialog, deselect any files that you do not wish to commit.
4. Review and edit (as appropriate) any changes to be committed.
5. Enter a commit comment.
6. Click Commit.
See the HTML version of this 
document to view the video. document to view the video.
You can use the confirmation dialog to compare your new version with any past version and to make any
necessary edits in the current version. Any changes you make as you review a file are included in the
committed file and saved in your project.
Save and Revert Changes to Projects
Work with Git and Subversion
2013-04-23 | ©2013 Apple Inc. All Rights Reserved.
265If you’re using Subversion, a commit operation copies the changes from selected files into the remote
Subversionrepository.Therefore, youmustbeconnectedtotherepositorybeforeyoucancommit changes.
(For details, see your repository administrator.)
If you’re using Git, the commit operation adds your changes to your local working copy. If you're using a
remote Git repository, youhave toperformapushoperationtoaddyour committedchanges tothe shared
repository.
A commit comment is required; the Commit button is disabled until you enter one. Good comments are
specific, but concise; suggested content includes a brief description of the changes, what they are meant
to accomplish, and URLs or ID numbers of any relevant bugs. The version editor displays the affected code
together with your name and commit comment, so you can omit information that’s in code comments or
that’s obvious from looking at the line of code.
The video shows committing changes in four files in the Sketch project to a local Git repository.
Tip: To commit one or a small number of files, select those files in the project navigator,
Control-click one of them, and choose Source Control > Commit Selected Files from the shortcut
menu.
Alternative: You can select the working copy in the repositories organizer navigation pane and
click the Commit button at the bottom of the Organizer window.
Reconcile Different Branches
When you’re ready to merge the code in a separate branch back into the main branch, or when you want to
combinethecodeinany twobranches, youcanusethemergefacilityof yoursourcecontrolsystemtoreconcile
differences between the branches.
Merge two branches to combine the code in them and reconcile differences between them.
To merge two branches
1. With the workspace window active, choose File > Source Control > Merge.
2. From the pop-up menu, choose the branch to merge into the current branch and click Choose.
3. Select a difference or conflict.
4. Use the left and right buttons to specify which file’s contents should be used.
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2665. After resolving all differences and conflicts, click Merge.
See the HTML version of this 
document to view the video. document to view the video.
Before merging, save and commit any unsaved changes in both branches. The Merge command merges a
branch that you choose into the current branch, so you may also need to switch the current branch before
the merge operation.
The left pane of the merge dialog shows what the merged file will look like. The right pane shows the file
with the changes to be merged in. For each difference between the files, an indicator in the center points
to the file taking precedence. To select a difference, click its indicator. You use the buttons at the bottom
to set the direction of the merge.
For example, if the difference is a line of code on the right that’s missing from the file on the left (your
working copy) click the Right button (which sets the indicator to the right) to specify that the line of code
be includedin the working copy when the merge is complete. Note thatbecause the leftpane shows what
the merged file will look like, you then see this line of code in both panes.
If a line of code hasbeen changedinboth versions of the filebeing merged, thedifferences are considered
a conflict and are shown in red. There are two additional buttons for reconciling conflicts by taking the
code lines from both files, either listing the ones in the left file first and those in the right file second, or
vice versa.
To reconcile any differences not handled by the four button choices, you can edit the file in the working
copy.
Update Your Working Copy from a Remote Repository
Whentwoormorepeople are workingona automataproject, fromtime totime youneedtosynchronize your
working copy with changes made in the remote repository. You use the Pull command in Git or the Update
command in Subversion to do so.
Use a pull operation to update local files with changes from a shared or remote Git repository to ensure that
your local repository is up to date.
To pull changes from a remote Git repository
1. Choose File > Source Control > Pull.
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2672. In the Pull dialog, select a file in the navigation pane.
3. Select a difference to reconcile by clicking its indicator.
4. Use the left and right buttons to specify how the difference is to be reconciled.
5. After reconciling all differences, click Pull to complete the operation.
Before you can push changes in your local repository to a shared repository, Git requires a pull operation,
in which you reconcile differences between the two repositories. This reconciliation helps prevent your
accidentally modifying or undoing other developers’ changes.
You need to save changes you’ve made and commit them to your local repository before pulling changes
from the shared repository.
In the Pull dialog, you select a difference by clicking the indicator between the two files. You then click one
of the four buttons at the bottom to choose how that difference is to be reconciled. The indicator updates
to reflect your choice.
A difference in which a line of code has been changed in both versions of the file is considered a conflict,
and its indicator is a question mark. You can’t complete the pull operation until you specify how to resolve
all conflicts.
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268If you wish, you can edit the local revision of the file in the Pull dialog to reconcile any differences not
handled by the four button choices.
In busy times , multiple developers may attempt to submit changes to the shared repository at the same
time. If another developer’s submission completes before yours, Xcode informs you that you must first
perform a new pull operation. In larger organizations, particularly just prior to a product release, you may
find that you have to pull changes more than once.
After the pull operation, you have to commit the changes files in your local repository that are updated by
the pull operation.
The illustration shows the Pull dialog, with a conflict selected.
Tip: To pull changes for one file or a small number of files, select those files in the project
navigator, Control-click one of them, and choose Source Control > Update Selected Files from
the shortcut menu that appears.
Update your local working copy with changes from a shared or remote Subversion repository to ensure that
your local copy is up to date.
To update changes from a remote Subversion repository
1. Choose File > Source Control > Update.
2. In the Update dialog, select a difference to reconcile.
3. Use the left and right buttons to specify which file’s contents should be used.
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2694. After reconciling all differences, click Update to complete the operation.
With a shared repository, there is a potential for one developer’s changes to undo or overwrite those of
another developer. To prevent this problem, Subversion requires that you update your local copy with the
changes already submitted to the shared repository.
Note: Youmusthaveanactivenetwork connectiontotheserver thatholdstheremoterepository.
You need to save changes you’ve made and commit them to your local repository before updating files
with changes from the shared repository.
In the update dialog, you select a difference by clicking the indicator between the two files. You then click
one of the four buttons at the bottom to choose how that difference is to be reconciled. The indicator
updates to reflect your choice.
A difference in which a line of code has been changed in both versions of the file is considered a conflict,
and its indicator is a question mark. You can’t complete the update operation until you specify how to
resolve all conflicts.
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270If you wish, you can edit the local revision of the file in the update dialog to reconcile any differences not
handled by the four button choices.
In busy times , multiple developers may attempt to submit changes to the shared repository at the same
time. If another developer’s submission completes before yours, Xcode informs you that you must first
perform a new update operation. In larger organizations, particularly just prior to a product release, you
may find that you have to update more than once.
After the update, you have to commit the changes files in your local repository that are updated by the
update.
The illustration shows the dialog for reconciling differences, with a conflict selected.
Tip: To update one file or a small number of files, select those files in the project navigator,
Control-click one of them, and choose Source Control > Update Selected Files from the shortcut
menu that appears.
Send Your Working Copy to the Remote Git Repository
If you’re using a remote Git repository, when you’re ready to share your work with the other members of your
team, youcanpushyour filesback tothe remote repository. (If you’reusingSubversion, the commit command
updates the remote repository.) If you cloned your working copy from a repository, you should see the remote
repository in the repository organizer. Before performing a push, you have to save and commit all changes
and execute the Pull command to reconcile any differences between your version and the one on the server.
Then, choose File > Source Control > Push.
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271Save Internal Project Files in Repositories
In Xcode 4.1 and later, you can use repositories to view internal project files (for example, schemes and user
interface settings) when looking at SCM details in the SCM commit and update workflows. You can use this
facility to save and keep track of versions of project files in the same way as you save and keep track of source
files. Figure 12-8 shows a commit dialog displaying two versions of a scheme.
Figure 12-8 A scheme in the commit dialog
Compare Revisions
You use the Xcode version editor to compare revisions. To compare any two versions of a file under source
control in a side-by-side view, select the file in the project navigator and click the version editor button (
). Use the jump bar underneath either editor pane to select the version of the file to compare with
the one in the other pane (Figure 12-9). You can select any committed version of that file in any branch.
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272Buttons under the version editor ( ) allow you to show a file comparison and timeline, change logs
for the file, or individual change annotations (“blame”) for each line of the file.
Figure 12-9 Comparing two revisions of a file with the version editor
You can edit the current working copy of the file in the version editor and you can copy code from an older
version and paste it into the current version.
Select Specific Revisions
Click the timeline icon ( ) in the center column to show a visual timeline of all repository versions; use the
sliders to control which version is displayed on each side.
Use the version timeline to choose file versions based on their chronological order.
To compare versions of a file with the timeline
1. With a source file open in the version editor, click the Comparison button.
2. Click the timeline viewer icon.
3. Browse the timeline with your pointer to reach the version you want to compare.
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2734. Click the right triangular indicator to open that version in the right editing pane.
See the HTML version of this 
document to view the video. document to view the video.
The version timeline is available in the comparison view. Clicking the timeline viewer icon displays the
timeline between the two editing panes.
You move the pointer (cursor) up or down through the timeline to browse the available versions. Versions
are listed chronologically, with a line for each version; newer versions are at the bottom of the timeline.
Each major division in the timeline groups revisions submitted within a twenty-four hour period.
Asyoureacheachversioninthetimeline,additionalinformationfor thatversionisdisplayedinanannotation.
When you find the version you want, click the left or right indicator triangle to display that version in the
corresponding editor pane. For example, the video shows choosing an older version of a file from the
repository (for display on the right) to compare it with the newer local version of that file (displayed on the
left).
Clicking the left indicator triangle allows you to compare another version in the left pane with the version
in the right.
Review Individual Changes
In blame mode, the current revision of the file is displayed along with the last revision that modified each line
of the file.
To see who is responsible for the last revision of a line of code
● Click the blame mode button at the bottom of the version editor.
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274Each blame mode entry is aligned with the line in the file where the change was made. The entry
includes the name of the person who committed the change, the date, and the ID of the commit.
Tip: Next to the entry is an arrow button. Click the arrow next to any change that interests you to see
that change displayed in Comparison mode.
View All Revisions Chronologically
To review all revisions to a file listed in chronological order, use Log mode. Each change is listed individually,
and you can click the arrow next to the log entry to see the change displayed in Comparison mode.
To review all revisions to a file
● Click the log mode button at the bottom of the version editor.
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275All the log entries for the file are listed in chronological order and include the name of the person who
committed the change, the date, the ID of the commit, and the commit comments.
Tip: Click the arrow next to any entry to see that change displayed in Comparison mode.
Tip: You can view all the commits for a project, listed by file, in the Organizer window. See "Why Use Source
Control?" (page 271) for details.
Distribute Your App
Archives package your products for distribution. Use archives to distribute your program through your own
distributionmechanismor tosubmit anapplicationtoiTunes Connect for inclusionintheiOSor Mac appstore.
To build your project and save the resulting application or a disk image of the set of build products, choose
Product > Archive. Xcode creates an archive of your project using the build configuration and name you
specified in the Archive pane of the scheme editor (Figure 3-2 (page 65)) and saves the archive in the location
specified in the Locations pane of Xcode preferences.
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276To see the archives for your project, open the archives organizer (Figure 12-10). You can add a comment by
clicking in the text field in the Comment column.
Figure
12-10
The archives organizer
For details on how to use archives to distribute your products, see "Distribute Your App" (page $@).
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1 Premiers contacts
Votre ordinateur iMac G5 a été conçu pour être configuré rapidement et être utilisé immédiatement. Si vous 
n’avez jamais utilisé d’iMac G5 ou n’êtes pas familiarisé 
avec les ordinateurs Macintosh, vous trouverez dans ce 
chapitre des instructions pour débuter. 
Si vous êtes un utilisateur expérimenté, peut-être êtes-vous déjà en mesure d’utiliser votre 
nouvel ordinateur. Veillez néanmoins à consulter les informations du chapitre 2, “Découverte de votre iMac G5”, pour découvrir les nouvelles fonctionnalités de cet iMac G5.
Câble CA Câble téléphonique
Clavier Souris
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Suivez les instructions des deux pages suivantes pour configurer votre iMac G5.
Étape 1 : Branchez le câble d’alimentation.
Étape 2 : Pour accéder à Internet, branchez un câble Ethernet ou un câble 
téléphonique.
W
G
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Étape 3 : Branchez les câbles du clavier et de la souris. 
Étape 4 : Appuyez sur le bouton d’alimentation (®) pour mettre l’ordinateur 
sous tension.
d
®
F3027Q45C\D.book Page 7 Thursday, April 7, 2005 3:18 PM8 Chapitre 1 Premiers contacts
Utilisation d’un clavier et d’une souris sans fil
Si vous avez fait l’acquisition d’un clavier Apple Wireless Keyboard et d’une souris Apple 
Wireless Mouse avec votre iMac G5, consultez les instructions fournies avec ces périphériques pour les configurer avec votre ordinateur.
Et ensuite ?
Grâce à ces étapes, votre iMac G5 est désormais opérationnel. La première fois 
que vous démarrez votre ordinateur, l’Assistant réglages se met en route. L’Assistant 
réglages vous aide à saisir les informations relatives à Internet et à votre courrier électronique ainsi qu’à configurer un utilisateur sur votre ordinateur. Si vous possédez déjà 
un ordinateur Mac, l’Assistant réglages peut également vous aider à transférer automatiquement des fichiers, des applications et d’autres informations de votre ancien Mac 
vers votre nouvel iMac G5.
Transfert d’informations vers votre iMac G5
Vous pouvez utiliser l’Assistant réglages pour transférer automatiquement des informations d’un autre Mac vers votre nouvel iMac G5. Pour transférer des informations, 
assurez-vous des points suivants :
Â Votre autre ordinateur Mac doit disposer d’un port FireWire intégré et prendre 
en charge le mode disque cible FireWire.
Â L’autre ordinateur Mac dont vous disposez doit Mac OS X 10.1 ou ultérieur installé.
Â Il vous faut un câble FireWire pour relier les deux ordinateurs.
L’Assistant réglages vous guide tout au long du processus de transfert d’informations ; 
il vous suffit de suivre les instructions à l’écran. Le transfert d’informations vers votre 
iMac G5 n’affecte pas les informations se trouvant sur votre autre Mac. Avec l’Assistant 
réglages, vous pouvez transférer :
Â les comptes d’utilisateur, y compris les préférences et le courrier électronique ; 
Â les réglages de réseau, pour que votre nouvel ordinateur soit automatiquement 
configuré avec les mêmes réglages de réseau que votre autre Mac ;
Â le dossier Applications, pour que les applications que vous utilisez sur votre autre 
Mac se trouvent à présent sur votre nouvel iMac G5 (certaines des applications transférées devront peut-être être réinstallées) ;
Â des fichiers et dossiers stockés sur votre disque dur. 
Si vous n’utilisez pas l’Assistant réglages pour transférer des informations lorsque vous 
démarrez votre iMac G5 pour la première fois, vous pouvez effectuer ce transfert plus 
tard à l’aide de l’Assistant migration. Pour cela, ouvrez le dossier Applications, ouvrez 
le dossier Utilitaires, puis double-cliquez sur l’icône Assistant migration.
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Remarque : si vous effectuez votre transfert d’informations à l’aide de l’Assistant migration, veillez à ce que FileVault soit désactivé sur votre ancien ordinateur. Pour désactiver 
FileVault, sélectionnez le menu Pomme () > Préférences Système, cliquez sur Sécurité, puis suivez les instructions qui s’affichent à l’écran.
Configuration de votre iMac G5 pour Internet
Si vous n’avez pas transféré vos réglages de réseau, l’Assistant réglages peut également vous guider tout au long de la configuration de votre ordinateur en vue de la 
connexion à Internet. Pour les particuliers, l’accès à Internet requiert généralement 
l’ouverture d’un compte auprès d’un fournisseur d’accès à Internet (FAI) (payant 
dans certains cas). Si vous disposez déjà d’un compte Internet, consultez l’annexe C, 
“Connexion à Internet”, à la page 67 pour savoir quelles sont les informations à saisir.
Informations supplémentaires
Pour obtenir davantage d’informations, consultez les sections suivantes : 
Procédure au terme de l’utilisation de votre iMac G5
Lorsque vous avez terminé de travailler avec votre iMac G5, suspendez l’activité 
de votre ordinateur ou éteignez-le.
Suspendre l’activité de votre iMac G5 afin d’économiser de l’énergie
Si vous envisagez de ne pas utiliser votre iMac G5 pendant une période inférieure à 
quelques jours, suspendez-en l’activité. Lorsque l’activité de l’ordinateur est suspendue, 
son écran s’éteint et une petite lumière blanche située dans l’angle inférieur droit de 
l’écran clignote. Vous pouvez le réactiver rapidement sans passer par la procédure 
de démarrage. 
Pour en savoir plus sur... Consultez...
L’extinction ou la suspension d’activité de votre 
ordinateur
“Procédure au terme de l’utilisation de votre 
iMac G5” ci-dessous.
L’utilisation des différentes parties de votre iMac 
G5 et la réalisation de certaines tâches courantes
le chapitre 2, “Découverte de votre iMac G5”.
La recherche d’informations supplémentaires 
disponibles dans l’aide à l’écran
“Obtention de réponses grâce à l’Aide Mac” à la 
page 22.
L’utilisation d’une fonctionnalité spécifique de 
l’iMac G5 ou la connexion d’un périphérique 
numérique tel qu’un iPod
le chapitre 3, “Utilisation de votre ordinateur”.
L’installation de mémoire le chapitre 4, “Extension des capacités de votre 
ordinateur”.
Le dépannage de votre iMac G5 en cas 
de problème
le chapitre 5, “Dépannage”.
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Pour suspendre rapidement l’activité de votre ordinateur, procédez de l’une 
des façons suivantes :
Â Choisissez Pomme () > Suspendre l’activité.
Â Appuyez sur le bouton d’alimentation situé à l’arrière de l’ordinateur.
Â Choisissez Pomme () > Préférences Système, cliquez sur Économiseur d’énergie 
et indiquez un délai pour suspendre l’activité.
Pour réactiver votre ordinateur, appuyez sur une touche quelconque du clavier. À la 
réactivation de l’ordinateur, vos applications, documents et réglages d’ordinateur réapparaissent exactement tels que vous les aviez laissés. 
Éteindre votre iMac G5
Si vous ne comptez pas utiliser votre iMac G5 pendant plusieurs jours, éteignez-le.
m Choisissez Pomme () > Éteindre.
Avertissement : éteignez votre iMac G5 avant de le déplacer. Tout déplacement de 
votre ordinateur lorsque le disque dur est en train de tourner risque d’endommager 
ce dernier et d’entraîner une perte de données ou l’impossibilité de démarrer à partir 
du disque dur.
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2 Découverte de votre iMac G5
Dans ce chapitre, vous trouverez des informations 
élémentaires à propos de votre iMac G5. 
La lecture de ce chapitre vous permettra d’avoir une vue d’ensemble sur les différents 
éléments de votre ordinateur et Mac OS X, et des informations sommaires sur les 
tâches basiques telles que personnaliser l’apparence du bureau, se connecter à une 
imprimante, lire un CD, connecter un appareil photo numérique, utiliser Internet, 
obtenir des réponses lorsque vous avez besoin d’aide, etc.
Pour obtenir les informations les plus récentes
Apple publiant fréquemment des nouvelles versions et mises à jour de ses logiciels 
système, il est possible que les images de ce manuel soient légèrement différentes 
de ce que vous voyez à l’écran.
Le site Web d’Apple, à l’adresse www.apple.com, vous donne accès aux informations, 
téléchargements gratuits et catalogues en ligne des logiciels et matériaux Apple les 
plus récents destinés à votre iMac.
Vous trouverez également les manuels de nombreux produits Apple, ainsi que l’assistance technique pour tous les produits Apple, sur le site Web de services et d’assistance 
www.apple.com/fr/support.
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iMac G5 – Vue avant
Ports USB
Haut-parleur intégré
Capteur de
lumière intégré Haut-parleur intégré
Micro intégré
Lecteur de disque optique 
à chargement par fente
Touche d’éjection de disque
Boutons de réglage 
du volume
Clavier Apple Keyboard Souris Apple Mouse
Voyant lumineux
d’alimentation
d C
-
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Lecteur de disque optique à chargement frontal
Votre ordinateur possède une unité combinée dite “Combo” DVD-ROM/CD-RW ou bien un SuperDrive DVD+R DL/DVD±RW/CD-RW. Tous ces lecteurs peuvent lire les CD-ROM, les CD de photos, les 
disques audio ordinaires et autres types de supports. Le lecteur Combo peut également lire les DVD 
et les DVD vidéo, graver de la musique, des documents et autres fichiers numériques sur des disques 
CD-R et CD-RW. De plus, le lecteur SuperDrive vous permet de lire et graver des DVD-R, DVD-RW, 
DVD+R, DVD+RW et des DVD+R double couche (DL).
Témoin lumineux d’alimentation
Un témoin blanc indique que l’ordinateur est en veille. Lorsque votre iMac G5 est allumé, 
ce voyant est éteint.
Micro intégré
Enregistrez des sons directement sur votre iMac G5 ou parlez avec des amis en direct sur Internet 
avec l’application intégrée iChat AV.
Haut-parleurs intégrés
Écoutez de la musique, le son de vos films, jeux et fichiers multimédia.
- Boutons de réglage du volume
Ces boutons permettent d’augmenter ou de baisser le volume du son provenant des haut-parleurs 
intégrés et du port de sortie audio.
C Touche d’éjection de disque
Maintenez cette touche enfoncée pour éjecter un CD ou un DVD. Il est également possible d’éjecter 
un disque en faisant glisser son icône dans la Corbeille.
Souris Apple Mouse
Utilisez la souris optique de précision sans tapis de souris sur la plupart des surfaces.
d Le clavier Apple Keyboard est doté de deux ports USB (Universal Serial Bus) 1.1
Branchez des périphériques USB 1.1 à faible consommation, tels qu’une souris, un appareil photo 
numérique ou une manette de jeu, au clavier de votre ordinateur iMac G5. Connectez votre souris 
Apple Mouse à l’un des ports USB du clavier (trois ports USB 2.0 haute vitesse se trouvent également 
à l’arrière de votre ordinateur).
Capteur de lumière intégré
Votre ordinateur est équipé d’un système qui capte la lumière ambiante et ajuste automatiquement la 
luminosité du témoin lumineux d’alimentation en fonction de la lumière disponible lorsque l’ordinateur est en veille.
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iMac G5 – Vue arrière
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Port de sortie casque/
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Port d’entrée audio
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G
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, Port d’entrée audio
Ce port permet l’entrée audio d’un microphone ou de tout autre appareil audio connecté à votre 
iMac G5.
f Port de sortie casque/sortie audio optique
Ce port permet de connecter des écouteurs ou tout autre périphérique de sortie audio. Il permet 
également de brancher votre iMac G5 à un récepteur, à un système home cinéma ou à tout autre 
équipement numérique audio à l’aide d’un câble audio optique muni d’une mini-prise.
£ Port de sortie vidéo
La carte VGA Apple facultative (disponible sur www.apple.com/francestore) vous permet de connecter 
à votre ordinateur un moniteur externe ou un projecteur utilisant un port VGA. L’adaptateur vidéo 
Apple (disponible sur www.apple.com/francestore) vous permet de connecter un téléviseur, un 
magnétoscope ou autre appareil vidéo doté d’un connecteur vidéo S-vidéo ou composite.
d Trois ports USB (Universal Serial Bus) 2.0
Ces ports vous permettent de raccorder des imprimantes, des lecteurs Zip ou autres, des appareils 
photo numériques, des manettes de jeu, etc. Vous pouvez brancher des appareils USB 1.1 et des 
appareils USB 2.0 à haute vitesse.
H Deux ports FireWire 400
Ces ports permettent de connecter des périphériques à haute vitesse tels qu’un iPod, des caméras 
vidéo numériques et des unités de stockage externes.
W Port modem (selon le modèle)
Il permet de connecter une ligne téléphonique standard directement au modem interne 56K v.92.
G Port Ethernet (10/100/1000Base-T)
Connectez-vous à un réseau Ethernet 10/100/1000 Base-T à grande vitesse ou à un modem câble ou 
DSL, ou bien connectez-vous à un autre ordinateur et transférez les fichiers. Le port Ethernet détecte 
automatiquement les autres périphériques Ethernet. Pour établir des connexions à d’autres périphériques Ethernet, il est inutile d’utiliser un câble croisé Ethernet.
® Bouton d’alimentation
Il permet d’allumer votre iMac G5 ou de suspendre son activité. Maintenez ce bouton enfoncé 
pour réinitialiser l’ordinateur lors des procédures de dépannage.
≤ Port secteur
Branchez-y le câble d’alimentation de l’ordinateur.
Logement de sécurité
Fixez un verrou et un câble antivol (disponibles sur le site www.apple.com/francestore).
Accès mémoire (à l’intérieur)
Votre iMac G5 contient au moins 512 mégaoctets (Mo) de mémoire DDR-SDRAM (Double Data Rate 
Synchronous Dynamic Random Access) PC 3200 à 400 MHz . Vous pouvez ajouter de la mémoire à 
votre iMac G5 afin d’obtenir jusqu’à 2 Go. Pour plus d’informations et d’instructions sur l’installation 
de mémoire, consultez la section “Ajout de mémoire” à la page 41.
Z AirPort Extreme 
Connectez-vous à un réseau sans fil grâce au module AirPort Extreme installé sur votre ordinateur
◊ Technologie sans fil Bluetooth®
Connectez-vous sans fil aux périphériques utilisant la technologie Bluetooth, tels que téléphones 
portables, assistants personnels (PDA) et imprimantes, ainsi qu’au clavier sans fil Apple Wireless 
Keyboard et à la souris sans fil Apple Wireless Mouse (le clavier et la souris Apple Wireless Keyboard 
and Mouse sont en vente sur le site www.apple.com/francestore).
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À propos de Mac OS X
Votre ordinateur est livré avec Mac OS X. Doté d’une interface utilisateur élégante 
et de capacités graphiques ultramodernes, ce système d’exploitation offre une 
plus grande stabilité et de meilleures performances du système. 
Pour en savoir plus sur Mac OS X et les applications iLife primées installées sur votre ordinateur, consultez le livret Bienvenue sur Tiger inclus avec votre iMac G5. Vous pouvez 
également ouvrir l’Aide Mac et parcourir les informations qu’elle contient. Vous trouverez 
un grand volume d’informations pour les utilisateurs novices et expérimentés, et pour 
ceux qui passent au Mac. Si vous rencontrez des problèmes lors de l’utilisation de 
Mac OS X, reportez-vous aux informations de dépannage au dos de ce manuel ou 
allez dans la barre des menus en haut de l’écran et sélectionnez Aide > Aide Mac.
Pour avoir des informations sur la compatibilité des applications logicielles avec 
Mac OS X, ou pour en savoir plus sur Mac OS X, visitez le site Web d’Apple : 
www.apple.com/fr/macosx.
Remarque : si vous voulez utiliser les applications Mac OS 9 avec votre ordinateur, 
vous devez installer Mac OS 9 (voir “Installation de Mac OS 9” à la page 56). Mac OS 9 
ne peut pas être installé comme système d’exploitation principal sur votre iMac G5 
et il n’est pas possible de démarrer l’ordinateur sous Mac OS 9.
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Personnalisation du bureau et réglage des préférences
Au moyen des Préférences Système, vous pouvez donner à votre bureau l’apparence 
souhaitée sans perdre de temps. Choisissez Pomme () > Préférences Système dans 
la barre des menus. 
N’hésitez pas à changer et essayer ce qui suit :
Â Bureau et économiseur d’écran : Sélectionnez cette sous-fenêtre de préférences 
pour changer la couleur et le motif du bureau ou pour la remplacer par la photo ou 
l’image de votre choix. Vous pouvez également choisir un effet d’écran accrocheur 
qui apparaîtra lorsque l’ordinateur reste inactif.
Â Dock : Sélectionnez cette sous-fenêtre de préférences pour changer l’apparence, 
l’emplacement et le comportement de votre Dock.
Â Apparence : Sélectionnez cette sous-fenêtre de préférences pour changer entre 
autres les couleurs des boutons, menus, fenêtres et la couleur de contraste.
Tout en vous familiarisant avec votre ordinateur, découvrez progressivement les autres 
Préférences Système. Il s’agit du centre de contrôle de la plupart des réglages de votre 
iMac G5. Pour plus d’informations, sélectionnez Aide > Aide Mac et recherchez “Préfé-
rences Système” ou la sous-fenêtre spécifique que vous souhaitez modifier.
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Connexion à une imprimante
Lorsque vous branchez une imprimante sur le port USB ou FireWire, votre iMac G5 peut 
la détecter automatiquement et l’ajouter à la liste des imprimantes utilisables. Il se peut 
que vous deviez configurer les imprimantes connectées à un réseau avant de pouvoir 
les utiliser.
Si vous avez une borne d’accès AirPort Extreme, vous pouvez y raccorder une imprimante USB (au lieu de la raccorder à votre ordinateur) et imprimer sans fil. 
Pour configurer une imprimante :
1 Ouvrez Préférences Système et cliquez sur l’icône Imprimer et faxer.
2 Cliquez sur Impression puis sur le bouton Ajouter (+) pour ajouter une imprimante.
3 Sélectionnez l’imprimante que vous souhaitez ajouter.
4 Utilisez les boutons Ajouter (+) et Supprimer (–) pour choisir les imprimantes 
que vous voulez voir apparaître dans la Liste des imprimantes.
Remarque : si vous vous connectez à une imprimante via un réseau, il vous faudra 
peut-être savoir le nom de réseau ou l’adresse de l’imprimante pour la sélectionner. 
Contactez votre administrateur système. 
Contrôle de l’impression
Lorsque vous avez envoyé un document à l’impression, vous pouvez contrôler 
l’impression, l’arrêter ou la mettre en attente temporairement.
Pour contrôler l’impression :
m Cliquez sur l’icône de l’imprimante dans le Dock pour ouvrir la fenêtre Liste 
des imprimantes. Vous voyez alors la liste des travaux d’impression et la file 
d’attente sur lesquelles vous pouvez intervenir. 
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Plus d’informations
Pour plus d’informations, ouvrez l’Aide Mac (voir la page 22) et recherchez “impression”. 
Pour réaliser une installation spécifique ou connaître les instructions de configuration, 
vous pouvez également vous reporter au manuel fourni avec votre imprimante.
Lecture d’un CD et connexion d’un casque d’écoute
Si vous souhaitez écouter de la musique pendant que vous travaillez sur votre iMac G5, 
insérez un CD dans le lecteur optique. iTunes, un lecteur de musique convivial, s’ouvre 
automatiquement. Pour une écoute privée, branchez des écouteurs dotés d’une prise 
mini-jack au port de sortie casque/sortie audio optique (f) de votre iMac G5. 
Pour en savoir plus sur iTunes :
m Ouvrez iTunes et choisissez Aide > Aide iTunes et Music Store. 
Pour en savoir plus sur votre lecteur optique, consultez la section “Utilisation de votre 
lecteur optique” à la page 36.
Mise à jour constante de vos logiciels
Vous pouvez vous connecter à Internet et télécharger et installer automatiquement les 
dernières versions de logiciels, gestionnaires et autres améliorations fournies par Apple. 
Une fois connecté à Internet, l’application Mise à jour de logiciels recherche dans les 
serveurs d’Apple les mises à jour disponibles pour votre ordinateur. Vous pouvez configurer votre Mac afin qu’il recherche régulièrement dans le serveur Apple des mises à 
jour de logiciels, puis qu’il les télécharge et les installe sur votre ordinateur.
Pour rechercher des logiciels mis à jour :
1 Choisissez Pomme () > Mise à jour de logiciels. La fenêtre Mise à jour de logiciels 
s’ouvre. Les mises à jour disponibles apparaissent dans une liste. 
2 Cochez les cases situées en regard des éléments à installer, puis cliquez sur Installer. 
3 Saisissez un nom et un mot de passe d’administrateur (utilisés lors de la configuration 
initiale de votre ordinateur).
Une fois les mises à jour terminées, l’application Mise à jour de logiciels recherche 
à nouveau des mises à jour. En effet, certaines mises à jour requièrent l’installation 
des mises à jour précédentes. Pour plus d’informations, effectuez une recherche sur 
“Mise à jour de logiciels” dans l’Aide Mac OS (voir la page 22).
Connexion d’une caméra ou d’autres périphériques FireWire
Si vous avez un iPod, une caméra iSight, un caméscope numérique FireWire ou autre 
périphérique équipé d’un connecteur FireWire, vous pouvez les connecter à votre iMac 
G5. Suivez les instructions d’installation fournies avec votre appareil. Pour plus d’informations à propos de FireWire, consultez “FireWire” à la page 26.
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Connexion à un réseau
Si vous souhaitez connecter votre iMac G5 à un réseau Ethernet, à un modem câble 
ou DSL ou à un réseau sans fil, consultez “Ethernet (10/100/1000Base-T)” à la page 32 
et “Réseau sans fil AirPort Extreme” à la page 28 pour plus d’informations sur la configuration d’une connexion Ethernet ou AirPort. Vous pouvez également consulter 
l’Aide Mac (voir la page 22) et y rechercher “Ethernet” ou “AirPort”.
Utilisation d’Internet
Lors du réglage initial de votre iMac G5, des instructions vous ont été données sur la 
manière de vous connecter à Internet. Pour utiliser une connexion de type différent, telle 
que par modem DSL ou câble, réseau local (LAN) Ethernet ou réseau AirPort Extreme, 
vous trouverez plus d’informations dans l’annexe C, “Connexion à Internet”, à la page 67.
Transfert de fichiers vers un autre ordinateur
Plusieurs solutions vous sont offertes pour transférer des fichiers ou des documents 
de ou vers votre iMac G5. 
Â Vous pouvez facilement transférer des fichiers à l’aide de l’Assistant réglages. Pour 
plus d’informations, consultez la section “Transfert d’informations vers votre iMac G5” 
à la page 8.
Â Vous pouvez transférer des fichiers via Internet en utilisant .Mac ou d’autres comptes 
Internet. Pour plus d’informations, rendez-vous sur le site www.mac.com.
Â Si votre ordinateur est connecté à un réseau Ethernet, vous pouvez transférer des 
fichiers vers un autre ordinateur en réseau. Pour accéder à un autre serveur ou ordinateur, ouvrez une fenêtre du Finder et cliquez sur Réseau. Si vous connaissez le nom 
ou l’adresse réseau de l’ordinateur, choisissez Aller > Se connecter au serveur dans la 
barre des menus du Finder.
Â Vous pouvez créer un réseau Ethernet de petite taille en reliant votre iMac G5 au port 
Ethernet d’un autre ordinateur à l’aide d’un câble Ethernet. Pour plus d’informations, 
ouvrez l’aide Mac OS et recherchez “Connexion de deux ordinateurs”.
Â Vous pouvez également vous connecter à un autre Mac au moyen d’un câble FireWire. 
Votre iMac G5 apparaît comme un lecteur de disque sur l’autre ordinateur. Vous pouvez 
alors transférer les fichiers. Pour plus d’informations sur l’utilisation de FireWire pour le 
transfert de fichiers, consultez la section “Mode disque cible FireWire” à la page 27. 
Â Vous pouvez vous connecter à un réseau sans fil AirPort pour transférer des fichiers. 
Pour plus d’informations, consultez la section “Réseau sans fil AirPort Extreme” à la 
page 28.
Pour plus d’informations sur le transfert de fichiers et de documents, ouvrez l’Aide Mac 
(voir la page 22) et recherchez “Création d’un petit réseau”.
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Lorsqu’une application ne répond pas
Même si c’est assez rare, il se peut qu’une application se fige à l’écran. Mac OS X permet 
de quitter une application qui ne répond plus sans redémarrer votre ordinateur, ce qui 
permet d’enregistrer le travail effectué dans d’autres applications ouvertes.
Pour forcer une application à quitter :
1 Appuyez sur Commande (x) + Option + Échap ou choisissez Forcer à quitter dans 
le menu Pomme ().
La zone de dialogue Forcer à quitter des applications apparaît avec l’application 
sélectionnée.
2 Cliquez sur Forcer à quitter.
L’application quitte, en laissant toutes les autres applications ouvertes.
Si besoin est, vous pouvez forcer la fermeture de l’environnement Classic, ce qui ferme 
alors toutes les applications Mac OS 9. Vous pouvez également redémarrer le Finder à 
partir de cette boîte de dialogue.
Si vous rencontrez d’autres difficultés, consultez le chapitre 5, “Dépannage”, à la page 53.
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Obtention de réponses grâce à l’Aide Mac
Vous pouvez trouver des réponses à la plupart de vos questions concernant l’utilisation 
de votre ordinateur et de Mac OS X dans l’Aide Mac.
Pour utiliser l’Aide Mac :
1 Cliquez sur l’icône du Finder dans le Dock.
2 Sélectionnez Aide > Aide Mac (cliquez sur le menu Aide et sélectionnez Aide Mac).
3 Tapez une question dans le champ “Posez une question”, puis appuyez sur la touche 
Retour du clavier.
4 Double-cliquez sur l’un des éléments apparaissant dans la liste des rubriques d’aide.
Utilisation des applications
Votre iMac G5 est fourni avec des logiciels, dont la suite iLife, qui vous permettront 
d’envoyer des messages électroniques, de naviguer sur Internet, de discuter en ligne, 
d’organiser vos morceaux de musique et vos photos numériques, de créer des vidéos 
et bien plus encore. Pour plus d’informations sur l’une de ces applications, ouvrez cette 
dernière puis l’Aide Mac correspondante.
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3 Utilisation de votre ordinateur
Votre iMac G5 comporte de nombreuses fonctionnalités 
et capacités d’extension intégrées permettant de le 
personnaliser selon vos besoins.
Voici quelques-unes des fonctionnalités et capacités de votre ordinateur :
Â Des ports USB (Universal Serial Bus) 2.0 à haute vitesse pour la connexion de matériel 
supplémentaire, tel qu’une imprimante, un scanneur, une manette de jeu, un clavier, 
un appareil photo numérique et un lecteur de disquettes. 
Â Des ports FireWire 400 pour la connexion de périphériques à haute vitesse, tels que 
l’iPod, la caméra iSight, des caméras vidéo numériques et des disques durs externes.
Â La technologie Bluetooth pour se connecter sans fil à des périphériques numériques.
Â Les toutes dernières technologies de communication, telles qu’un modem 56K v.92 
(sur certains modèles), une carte Ethernet 10/100/1000 Base-T et une connexion de 
réseau sans fil AirPort Extreme. 
Â Port combiné sortie casque/sortie audio optique, pour connecter des écouteurs 
ou un équipement audio numérique.
Â La sortie VGA et l’adaptateur VGA (disponibles sur www.apple.com/francestore) vous 
permettent de connecter votre iMac G5 à un moniteur externe ou à un appareil de 
projection. Utilisez le port de sortie vidéo de votre ordinateur iMac G5 et l’adaptateur 
vidéo Apple (disponible sur www.apple.com/francestore) pour afficher l’écran de votre 
ordinateur sur n’importe quel téléviseur gérant le format composite ou S-vidéo.
Pour en savoir plus sur les capacités de votre iMac G5, commencez par lire ce chapitre. 
Vous trouverez des informations supplémentaires dans l’Aide Mac (voir la page 22) et 
sur le site Web Service & Support d’Apple à l’adresse www.apple.com/fr/support.
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USB (Universal Serial Bus)
Votre iMac G5 est muni de cinq ports USB (d) (trois ports à haute vitesse USB 2.0 sur 
l’ordinateur et deux ports USB 1.1 sur le clavier) que vous pouvez utiliser pour connecter 
de nombreux types de périphériques tels que les imprimantes, scanners, appareils photo 
numériques, manettes de jeu, claviers et lecteurs de disquette. La technologie USB facilite la connexion de périphériques. Dans la plupart des cas, vous pouvez connecter et 
déconnecter un périphérique USB pendant que l’ordinateur fonctionne. Vous pouvez 
utiliser les périphériques dès leur branchement,
Utilisation de périphériques USB
Pour utiliser un périphérique USB avec votre ordinateur, il suffit de connecter le périphérique à l’ordinateur. L’ordinateur charge le logiciel adéquat chaque fois que vous 
connectez un nouveau périphérique. 
Les ports USB 2.0 situés à l’arrière de l’ordinateur vous permettent de brancher 
des périphériques USB 1.1 et USB 2.0 à haute vitesse. Les périphériques USB 1.1 
ne bénéficieront pas du taux de transfert plus rapide de l’USB 2.0. 
De même, vous pouvez brancher des périphériques USB 2.0 sur les ports USB 1.1 
du clavier, mais ils fonctionneront peut-être à des vitesses moindres.
Remarque : Apple fournit d’origine des logiciels compatibles avec de nombreux périphériques USB. Si votre iMac G5 ne trouve pas le logiciel adéquat pour un périphérique 
USB connecté, vous pouvez installer le logiciel fourni avec ce périphérique ou consulter 
le site Web du fabricant pour connaître les dernières versions.
Ports USB
d
d
d
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Utilisation simultanée de plusieurs périphériques USB
Si tous vos ports USB sont occupés et que vous souhaitez connecter davantage de périphériques USB, vous pouvez vous procurer un concentrateur USB. Ce dernier se connecte 
à un port USB disponible de votre ordinateur et vous permet de disposer de ports USB 
supplémentaires (en général quatre ou sept). La plupart des concentrateurs USB disposent d’un adaptateur secteur et doivent être branchés sur une prise électrique.
Informations supplémentaires sur la technologie USB
Des informations supplémentaires sur USB sont disponibles dans l’Aide Mac (consultez 
la page 22). Choisissez Aide > Aide Mac et recherchez “USB”. Vous trouverez d’autres 
informations sur le site Web USB d’Apple, à l’adresse www.apple.com/fr/usb.
Pour obtenir des informations sur les périphériques USB disponibles pour votre ordinateur, consultez le Guide des produits Macintosh à l’adresse www.apple.com/fr/guide.
Concentrateur USB
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FireWire
Votre ordinateur est muni de deux ports FireWire 400 (H). FireWire facilite la connexion et 
déconnexion des périphériques haute vitesse, tels que l’iPod, la caméra iSight, les caméras 
vidéo numériques, les imprimantes, les scanneurs et les disques durs. Vous pouvez 
connecter et déconnecter des périphériques FireWire sans redémarrer votre ordinateur. 
La liste ci-dessous répertorie certaines des opérations possibles avec FireWire :
Â Connecter un iPod et transférer des milliers de chansons provenant d’iTunes 
ou synchroniser vos adresses et les données de votre agenda à l’aide d’iSync.
Â Connecter une caméra iSight Apple et utiliser l’application iChat AV fournie pour 
participer à une vidéoconférence avec vos amis ou votre famille via une connexion 
Internet à haut débit.
Â Connecter une caméra vidéo numérique pour capturer, transférer et faire des montages 
vidéo de grande qualité directement sur votre ordinateur au moyen de logiciels 
de montage vidéo tels qu’iMovie (fourni avec votre ordinateur), Final Cut Express 
ou Final Cut Pro.
Â Connecter un disque dur FireWire externe sur le port FireWire et l’utiliser pour sauvegarder des données ou transférer des fichiers. Une icône de disque dur FireWire 
s’affiche sur le bureau dès que vous connectez le disque dur à votre iMac G5. 
Â Démarrer à partir d’un disque dur externe FireWire. Connectez un disque FireWire 
externe (équipé d’un système d’exploitation valide), ouvrez la sous-fenêtre Démarrage 
des Préférences Système, et cliquez sur le disque FireWire. Redémarrez votre ordinateur.
Ports FireWire
H
H
F3027Q45C\D.book Page 26 Thursday, April 7, 2005 3:18 PMChapitre 3 Utilisation de votre ordinateur 27
Utilisation de périphériques FireWire
Pour utiliser un périphérique FireWire avec votre ordinateur, il suffit de connecter ce 
périphérique à l’ordinateur. Apple fournit d’origine des logiciels compatibles avec de 
nombreux périphériques FireWire. Si votre iMac G5 ne trouve pas le logiciel adéquat 
pour un périphérique FireWire connecté, vous pouvez installer le logiciel fourni avec 
ce périphérique ou consulter le site Web du fabricant pour obtenir les dernières versions.
Remarque : le port FireWire est conçu pour alimenter les périphériques FireWire (8 watts 
maximum). Vous pouvez connecter plusieurs périphériques entre eux et relier en chaîne 
les périphériques (“guirlande”) au port FireWire de votre ordinateur. Dans la plupart des 
cas, l’ordinateur ne doit pas alimenter plus de deux périphériques. Si vous connectez plus 
de deux périphériques, les autres périphériques de la guirlande doivent être alimentés au 
travers d’adaptateurs électriques séparés. Connecter plus de deux périphériques FireWire 
alimentés par l’ordinateur peut provoquer des problèmes. En cas de problème, éteignez 
l’ordinateur, déconnectez les périphériques FireWire, puis redémarrez l’ordinateur.
Mode disque cible FireWire
Si vous souhaitez transférer des fichiers de votre iMac G5 vers un autre ordinateur équipé 
de la technologie FireWire ou êtes confronté à un problème empêchant le démarrage 
de votre ordinateur, utilisez le mode disque cible FireWire pour vous connecter à un 
autre ordinateur.
Pour connecter votre iMac G5 en mode disque cible FireWire, procédez 
de la manière suivante :
1 Assurez-vous que votre iMac G5 est éteint.
2 Utilisez un câble FireWire muni d’un connecteur standard à 6 broches à chaque 
extrémité pour connecter votre iMac G5 à un autre ordinateur équipé de FireWire.
3 Démarrez votre iMac G5 et appuyez immédiatement sur la touche T en la maintenant 
enfoncée. 
Le logo FireWire s’affiche sur l’écran de votre iMac G5. L’écran de l’autre ordinateur 
affiche l’icône du disque dur interne de votre iMac G5 et l’icône d’un CD ou d’un DVD 
inséré dans le lecteur optique de votre iMac G5.
4 Faites glisser l’icône du disque dur de l’iMac G5 et l’icône du CD ou DVD dans la Corbeille 
lorsque vous avez terminé le transfert de fichiers.
5 Appuyez sur le bouton d’alimentation du de l’iMac G5 pour l’éteindre.
6 Débranchez le câble FireWire.
Informations supplémentaires sur la technologie FireWire
Des informations supplémentaires sur FireWire sont disponibles dans l’Aide Mac 
(consultez la page 22). Choisissez Aide > Aide Mac, puis recherchez “FireWire”. 
Vous trouverez d’autres informations sur le site Web FireWire d’Apple, à l’adresse 
www.apple.com/fr/firewire.
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Réseau sans fil AirPort Extreme
La technologie AirPort Extreme est déjà installée sur votre iMac G5. AirPort permet 
d’accéder sans fil à Internet en toute simplicité et sans vous ruiner n’importe où, 
que ce soit chez vous, au bureau ou dans un établissement scolaire. Au lieu de faire 
appel à des câbles classiques, AirPort utilise la technologie de réseau local (LAN) sans 
fil permettant une communication sans fil entre plusieurs ordinateurs. Un réseau sans 
fil vous permet d’établir un accès à Internet, de transférer des fichiers, de jouer à 
plusieurs, etc.
Remarque : vous aurez également besoin d’une borne d’accès AirPort et d’un accès 
à Internet (ce service peut être payant). Certains fournisseurs d’accès à Internet ne 
sont pas encore compatibles avec AirPort. La portée varie en fonction des conditions 
d’emplacement.
Fonctionnement de l’accès sans fil à Internet via AirPort
Le système AirPort permet d’établir une connexion sans fil avec un appareil appelé 
borne d’accès qui dispose, lui, d’une connexion physique à Internet. La technologie 
AirPort fonctionne comme un téléphone sans fil. Grâce à la technologie AirPort 
Extreme, votre ordinateur établit une connexion sans fil à une borne d’accès, ellemême connectée à Internet via une ligne téléphonique ou un modem DSL ou câble.
Connexion 
à Internet
Sortie CA 
Antennes AirPort
Modem câble
ou DSL
Borne d’accès
AirPort Express 
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Informations complémentaires à propos d’AirPort
Pour acheter une borne d’accès AirPort, contactez votre fournisseur agréé Apple 
ou rendez-vous sur le site Web Apple Store, à l’adresse www.apple.com/francestore.
Des informations supplémentaires sur AirPort sont disponibles dans l’Aide AirPort. 
Sélectionnez Aide > Aide Mac, puis Centre d’aide > Aide AirPort. Vous pouvez 
également trouver des informations sur le site Web AirPort d’Apple à l’adresse 
www.apple.com/fr/airport.
Technologie sans fil Bluetooth
La technologie Bluetooth est déjà installée sur votre iMac G5. Cette dernière vous permet 
de créer des connexions sans fil de faible portée entre des ordinateurs de bureaux et 
portables, des assistants personnels, des téléphones portables, des téléphones appareils 
photo, des imprimantes, des appareils photo numériques et des périphériques d’entrée 
sans fil tels que le clavier Apple Wireless Keyboard ou la souris Apple Wireless Mouse 
(disponibles à la vente sur le site www.apple.com/francestore). 
La technologie sans fil Bluetooth permet d’éliminer les câbles reliant normalement les 
périphériques. Les périphériques prenant en charge Bluetooth peuvent se connecter 
l’un à l’autre sans besoin de liaison physique, dans la mesure où ils sont séparés d’une 
distance égale ou inférieure à 10 mètres.
Avec la technologie sans fil Bluetooth, vous pouvez :
Â Utiliser votre iMac G5 pour communiquer avec un téléphone mobile prenant en charge 
la technologie Bluetooth. Votre téléphone peut servir de modem pour vous connecter 
à un fournisseur de services sans fil, à un débit de 56 kilobits par seconde (Kbps) 
suffisant pour vous connecter à Internet.
Â Échanger des fichiers entre ordinateurs et périphériques prenant en charge Bluetooth, 
même entre Mac et PC. Apple recommande l’utilisation du réseau sans fil AirPort 
Extreme pour le transfert de tous vos fichiers à l’exception des plus petits.
Â Synchroniser des données entre votre ordinateur et un assistant personnel compatible 
Bluetooth. À l’aide d’iSync, vous pouvez exécuter une opération HotSync sans fil ou 
transmettre votre carte de visite ou encore des événements de calendrier directement 
sur le PDA d’un collègue.
Â Utiliser un clavier ou une souris sans fil Bluetooth.
Â Imprimer vers une imprimante Bluetooth.
Â Utiliser un casque d’écoute Bluetooth.
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Configuration d’un périphérique Bluetooth :
Avant de pouvoir utiliser votre téléphone mobile pour accéder à Internet ou échanger 
des informations de contact, partager des fichiers avec d’autres périphériques, ou encore 
utilisez un clavier ou une souris Bluetooth, vous devez configurer le périphérique pour 
qu’il fonctionne avec votre ordinateur. Une fois le périphérique configuré, il est “jumelé” 
avec votre ordinateur et apparaît dans la sous-fenêtre Périphériques des Préférences 
Bluetooth. Vous n’avez à jumeler l’ordinateur et le périphérique qu’une seule fois et 
les deux appareils restent alors jumelés jusqu’à ce que vous en décidiez autrement.
Pour configurer un périphérique Bluetooth :
1 vous pouvez également choisir “Configurer l’appareil Bluetooth” dans le menu d’état 
Bluetooth (◊) de la barre des menus.
2 Suivez les instructions affichées à l’écran pour le type de périphérique que vous 
souhaitez configurer.
Important : si le menu d’état Bluetooth (◊) ne se trouve pas dans la barre des menus, 
ouvrez les Préférences Système et cliquez sur Bluetooth. Cliquez sur Réglages, puis 
sélectionnez “Afficher l’état Bluetooth dans la barre des menus”.
Pour supprimer un jumelage avec un autre périphérique :
1 Ouvrez Préférences Système, puis cliquez sur Bluetooth. 
2 Cliquez sur Périphériques et choisissez le périphérique dans la liste. 
3 Cliquez alors sur Supprimer le jumelage.
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Configuration de l’échange de fichiers Bluetooth
Vous pouvez contrôler la manière dont l’ordinateur gère les fichiers échangés entre 
appareils Bluetooth. Vous pouvez choisir d’accepter ou de refuser les fichiers envoyés 
à votre ordinateur, dans quel dossier placer les fichiers reçus et acceptés, les dossiers 
de votre ordinateur que les autres appareils Bluetooth peuvent consulter et les applications à utiliser pour exploiter les fichiers acceptés.
Pour configurer un échange de fichiers Bluetooth :
1 Ouvrez Préférences Système, puis cliquez sur Bluetooth.
2 Cliquez sur Partage.
3 Cochez la case Activé pour l’Échange de fichiers Bluetooth, puis utilisez les menus 
locaux pour paramétrer les réglages.
Envoi d’un fichier à un appareil Bluetooth
Votre ordinateur peut envoyer des fichiers vers d’autres appareils Bluetooth situés 
dans la zone de couverture de votre ordinateur. Si votre ordinateur n’est pas jumelé 
avec l’appareil, il se peut que vous deviez vous authentifier auprès de ce dernier avant 
de pouvoir envoyer le fichier. Si vous avez déjà jumelé l’ordinateur à l’appareil, vous 
ne devriez pas avoir à vous authentifier.
Pour envoyer un fichier à un appareil Bluetooth :
1 Choisissez Envoyer un fichier dans le menu d’état Bluetooth de la barre des menus.
2 Sélectionnez le fichier que vous souhaitez envoyer puis cliquez sur Envoyer.
3 Choisissez un appareil dans la liste Appareil, puis cliquez sur Envoyer.
Si l’appareil ne se trouve pas dans la liste, cliquez sur Rechercher. Une fois l’appareil 
retrouvé, vous pouvez l’ajouter à votre liste de favoris.
Pour plus d’informations sur la technologie sans fil Bluetooth
Pour accéder à l’aide Bluetooth, ouvrez l’applications Échange de fichiers 
Bluetooth (dans le dossier Utilitaires du dossier Applications) et sélectionnez 
Aide > Aide Bluetooth. Vous trouverez d’autres informations sur le site Web 
d’Apple, à l’adresse www.apple.com/fr/bluetooth.
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Ethernet (10/100/1000Base-T)
Votre ordinateur est doté de la technologie de mise en réseau Ethernet 10/100/1000 
mégabits par seconde (Mbps) Base-T (paire torsadée), qui permet de vous connecter 
à un réseau ou à un modem câble ou DSL. 
La connexion à un réseau vous donne accès à d’autres ordinateurs et vous permet 
de stocker et de récupérer des informations, d’utiliser les imprimantes d’un réseau, 
des modems et une messagerie électronique ou de vous connecter à Internet. Vous 
pouvez également partager des fichiers entre deux ordinateurs ou établir un petit 
réseau. Le port Ethernet de votre iMac G5 détecte automatiquement les autres périphériques Ethernet. Pour établir des connexions à d’autres périphériques Ethernet, 
il est inutile d’utiliser un câble croisé.
Â Utilisez un câble Ethernet de catégorie 3 (Cat 3) à quatre paires pour vous connecter 
à un réseau Ethernet 10 Base-T.
Â Utilisez un câble Ethernet de catégorie 5 (Cat 5) à deux paires pour vous connecter 
à un réseau Ethernet 10 Base-T, 100 Base-T ou 1000 Base-T.
Informations supplémentaires sur l’utilisation d’Ethernet
Des informations supplémentaires, expliquant notamment comment établir un réseau 
Ethernet et transférer des fichiers via Ethernet, sont disponibles dans l’Aide Mac 
(reportez-vous à la page 22). Choisissez Aide > Aide Mac, puis recherchez “Ethernet” 
ou “réseau”. Pour obtenir des informations sur les produits réseau que vous pouvez 
utiliser avec votre iMac G5, consultez le guide des produits Macintosh à l’adresse 
www.apple.com/fr/guide.
Port Ethernet
(10/100/1000Base-T)
G
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Support audio
Votre iMac G5 est doté d’un dispositif audio complet, notamment un port combinant 
une sortie casque/sortie audio optique permettant de brancher des écouteurs ou un 
équipement audio numérique, ainsi qu’un port d’entrée audio analogique. 
Port de sortie casque/sortie audio optique
Pour écouter de la musique sans déranger les personnes autour de vous, branchez 
une paire d’écouteurs sur le port combiné de sortie casque/sortie audio optique (f). 
Vous pouvez également connecter votre iMac G5 à un récepteur AV à l’aide d’un câble 
audio optique doté d’une mini-prise pour établir un système de home cinéma basé sur 
votre iMac G5. 
Port de sortie casque/
sortie audio optique 
fdigital
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Port d’entrée audio
Au dos de l’ordinateur, le port d’entrée audio analogique (,) permet de connecter 
un microphone externe sous tension ou d’autres équipements audio pour importer 
de l’audio. 
Pour sélectionner le périphérique audio d’entrée ou de sortie à employer, utilisez 
la sous-fenêtre Son des Préférences Système.
Informations supplémentaires sur l’utilisation de l’audio
L’Aide Mac contient des informations supplémentaires sur l’utilisation de l’audio 
(voir la page 22). Choisissez Aide > Aide Mac, puis recherchez “audio” ou “musique.” 
Pour obtenir des informations sur les produits audio et de musique que vous pouvez 
utiliser avec votre iMac G5, consultez le guide des produits Macintosh à l’adresse 
www.apple.com/fr/guide.
Gestion de vidéo externe (VGA, Composite et S-Vidéo)
Votre ordinateur dispose d’un port de sortie vidéo qui vous permet de le connecter 
à un moniteur (écran) externe ou à un projecteur VGA à l’aide de l’adaptateur VGA 
(disponible sur www.apple.com/francestore). 
Vous pouvez également afficher ou enregistrer des images en connectant un téléviseur, 
un projecteur vidéo ou un magnétoscope à l’aide de l’adaptateur vidéo Apple (disponible 
sur www.apple.com/francestore).
Port d’entrée audio
,
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Remarque : l’adaptateur vidéo d’Apple n’est pas compatible avec certains modèles 
antérieurs d’iMac.
Lorsque votre iMac G5 est connecté à un moniteur externe ou à un téléviseur, la même 
image apparaît sur son écran et sur le moniteur externe (mode appelé recopie vidéo).
Remarque : en raison des limitations d’affichage de la plupart des téléviseurs, la qualité 
des images affichées sur un téléviseur sera inférieure à celle des images affichées par 
l’écran intégré ou un moniteur externe.
Connexion d’un écran externe ou d’un projecteur
Pour connecter un écran externe ou un projecteur à votre ordinateur à l’aide 
d’une connexion VGA :
1 Allumez l’écran externe ou le projecteur.
2 Connectez l’adaptateur VGA Apple au port VGA du moniteur externe ou du projecteur.
3 Connectez l’adaptateur de moniteur VGA d’Apple à votre iMac G5. Votre iMac G5 
détecte automatiquement l’écran externe.
Important : pour être sûr que votre iMac G5 détecte automatiquement le moniteur 
externe ou le projecteur, veillez à d’abord brancher l’adaptateur VGA à ce moniteur 
externe ou projecteur.
4 Utilisez la sous-fenêtre Moniteurs des Préférences Système pour régler la résolution 
du moniteur externe ou du projecteur.
Port de sortie vidéo
£
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Connexion d’un téléviseur, d’un magnétoscope ou de tout autre 
appareil vidéo
Pour connecter un téléviseur, un magnétoscope ou tout autre appareil vidéo 
à votre iMac G5 :
1 Connectez l’extrémité munie d’une seule fiche de l’adaptateur vidéo d’Apple au port 
de sortie vidéo de votre iMac G5. 
2 Connectez l’autre extrémité de l’adaptateur au port vidéo composite ou S-vidéo 
du téléviseur ou du magnétoscope.
3 Allumez l’appareil.
4 Pour régler l’apparence des images affichées à l’écran, ouvrez la sous-fenêtre 
Moniteurs des Préférences Système.
L’image apparaît alors à la fois sur l’iMac G5 et sur le téléviseur.
Informations supplémentaires sur l’utilisation d’un moniteur 
externe ou d’un téléviseur
Vous pourrez trouver des informations supplémentaires sur la configuration 
et l’utilisation d’un moniteur externe dans l’Aide Mac. Choisissez Aide > Aide Mac, 
puis recherchez “moniteur”. 
Utilisation de votre lecteur optique
Votre lecteur optique permet d’installer ou d’exécuter des applications à partir de CD 
et de DVD. Vous pouvez écouter de la musique à partir d’un CD audio et regarder des 
films sur DVD. Vous pouvez également graver des CD de musique lisibles sur la plupart 
des lecteurs de CD et enregistrer des documents et autres fichiers numériques sur des 
CD-R et CD-RW. 
Important : le lecteur optique de votre iMac G5 est compatible avec les disques circulaires standard de 12 cm. Les disques d’une autre forme ou d’un diamètre inférieur à 
12 cm ne sont pas compatibles. Les disques non circulaires ou plus petits risquent de 
se coincer dans le lecteur. En cas de disque coincé, reportez-vous aux informations de 
dépannage à la page 57.
Si votre iMac G5 possède un lecteur SuperDrive, vous pouvez également graver des 
vidéos familiales en réalisant des DVD vidéo qui pourront être lus sur la plupart des 
lecteurs de DVD de salon, ou bien enregistrer des documents et autres fichiers numériques sur des disques DVD-R, DVD-RW, DVD+R, DVD+RW et DVD+R Double couche (DL) 
vierges, en utilisant le Finder ou iDVD. Vous pouvez placer près de deux fois plus de 
données (8,54 Go) sur un disque DVD+R DL (double couche).
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Remarque : si vous possédez des logiciels anciens sur disquette, demandez à l’éditeur 
s’ils sont disponibles sur CD ou téléchargeables en ligne ou achetez un lecteur de 
disquette externe USB pour votre iMac G5 auprès d’un distributeur Apple ou sur 
le site Apple Store (www.apple.com/francestore).
Insertion d’un CD ou DVD
Pour installer ou utiliser des logiciels à partir d’un disque CD-ROM ou DVD-ROM, 
procédez comme suit :
1 Insérez le disque dans le lecteur optique, en plaçant l’étiquette vers vous.
2 Dès que son icône apparaît sur le bureau, le disque peut être utilisé.
Remarque : certains disques DVD sont à double face.
Éjection d’un disque
Pour éjecter un disque, procédez comme suit :
Â Glissez l’icône du disque dans la Corbeille.
Â Maintenez enfoncée la touche d’éjection de disque (C) sur le clavier jusqu’à 
ce que le disque soit éjecté.
Si vous ne parvenez pas à éjecter le disque, fermez toutes les applications susceptibles 
d’utiliser le disque et réessayez. Si cela ne donne pas de résultats, redémarrez l’ordinateur tout en maintenant le bouton de la souris enfoncé.
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Lecture de DVD
Insérez le DVD que vous voulez lire. L’application Lecteur DVD s’ouvre automatiquement 
et lance la lecture du disque.
Si vous avez connecté l’iMac G5 à un téléviseur pour regarder vos DVD sur l’écran du 
téléviseur, sélectionnez 720 x 480 NTSC (aux États-Unis) ou 720 x 576 PAL (en Europe 
et dans d’autres régions) dans la sous-fenêtre Moniteurs des Préférences Système.
Il est très facile de connecter votre iMac G5 à une chaîne stéréo. Utilisez un câble audio 
optique muni d’un connecteur mini-prise (en vente sur www.apple.com/francestore) 
pour relier le port de sortie combiné casque/sortie audio optique (f) de votre iMac G5 
au port d’entrée audio optique de votre récepteur stéréo.
Enregistrement de disques CD-R et CD-RW
Vous pouvez enregistrer des disques CD-R ou CD-RW directement à partir de votre 
bibliothèque iTunes.
Pour enregistrer de la musique sur un CD-R ou CD-RW via iTunes :
1 Cliquez sur l’icône d’iTunes dans le Dock.
2 Sélectionnez la liste de lecture à enregistrer.
3 Insérez un disque vierge CD-R ou CD-RW. (Pour une compatibilité optimale avec 
les lecteurs CD, utilisez un CD-R).
4 En haut de la fenêtre iTunes, cliquez sur l’option Graver le CD.
Pour enregistrer vos fichiers et dossiers sur un CD-R ou CD-RW à l’aide du Finder :
1 Insérez un disque vierge dans le lecteur optique.
2 Dans la zone de dialogue qui apparaît, attribuez un nom au disque. Une icône correspondant au CD apparaît sur le bureau.
3 Glissez des fichiers et dossiers sur l’icône du disque.
4 Choisissez Fichier > Graver le disque ou sélectionnez le disque, puis glissez-le sur l’icône 
“Graver le disque“ située dans le Dock.
Pour plus d’informations
Â Pour obtenir des informations sur l’enregistrement de fichiers de musique sur un 
CD-R à l’aide d’iTunes, ouvrez iTunes et choisissez Aide > Aide iTunes et Music Store.
Â Pour obtenir des instructions sur l’utilisation de l’application Lecteur DVD, ouvrez 
Lecteur DVD et choisissez Aide > Aide Lecteur DVD.
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Enregistrement d’informations sur un DVD
Si votre iMac G5 est équipé d’un lecteur SuperDrive, vous pouvez graver vos vidéos 
numériques familiales sur DVD+R DL (double couche), DVD±RW ou DVD±R. Vous 
pouvez également enregistrer d’autres types de données numériques (vous pouvez 
sauvegarder vos fichiers par exemple).
Pour graver des données sur un DVD-R à l’aide du Finder :
1 Insérez un DVD+R DL (double couche), un DVD±RW ou un DVD±R vierge dans 
le lecteur. 
2 Dans la zone de dialogue qui apparaît, attribuez un nom au disque et sélectionnez 
le format souhaité. Une icône représentant le DVD apparaît sur le bureau.
3 Double-cliquez sur l’icône du DVD, puis glissez-y des fichiers et des dossiers.
4 Choisissez Fichier > Graver le disque ou sélectionnez le disque, puis glissez-le 
sur l’icône “Graver le disque“ située dans le Dock.
Vous pouvez également utiliser iDVD pour créer vos propres DVD personnalisés, les 
graver sur DVD vierge et les lire ensuite sur la plupart des lecteurs de DVD standard. 
Pour plus d’informations sur l’utilisation d’iDVD, ouvrez iDVD et choisissez Aide > 
Aide iDVD.
Commandes du clavier
Les commandes clavier vous permettent de régler rapidement le volume ou d’éjecter 
un CD ou un DVD.
Pour augmenter le contraste de l’écran, appuyez sur la touche F15 de votre clavier. 
Pour diminuer le contraste, appuyez sur la touche F14. 
Avec Exposé, vous pouvez facilement gérer les fenêtres sur l’écran. Pour voir toutes 
les fenêtres ouvertes d’un seul coup d’œil, appuyez sur F9. Pour voir toutes les fenêtres 
ouvertes dans l’application active, appuyez sur F10. Pour masquer toutes les fenêtres 
ouvertes pour pouvoir visualiser le bureau, appuyez sur F11. 
Diminution 
du volume
Augmentation
du volume
Touche de 
mode silencieux
Touche d’éjection 
de disque
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Protection de votre ordinateur
Insérez un câble de verrouillage (disponible sur www.apple.com/francestore) 
dans le logement de sécurité intégré pour attacher votre iMac G5 à un objet fixe.
Des informations supplémentaires sur les fonctionnalités logicielles de sécurité de votre 
iMac G5, y compris les mots de passe d’utilisateurs multiples et le cryptage des fichiers, 
sont disponibles dans l’Aide Mac (voir la page 22). Choisissez Aide > Aide Mac, puis 
recherchez “sécurité” ou “utilisateurs multiples”.
Logement
de sécurité
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4 Extension des capacités de votre 
ordinateur
Ce chapitre fournit des informations et des instructions 
pour l’extension des capacités de votre ordinateur. 
Vous y trouverez des instructions sur les opérations suivantes :
Â “Ajout de mémoire” à la page 41.
Â “Remplacement de la pile de secours interne” à la page 48.
Ajout de mémoire
Votre iMac G5 contient au moins 512 mégaoctets (Mo) de mémoire DDR-SDRAM 
(Double Data Rate Synchronous Dynamic Random Access). Votre iMac G5 dispose 
par ailleurs de deux logements de mémoire, dont l’un est généralement libre en vue 
d’éventuelles extensions. Il est compatible avec les modules de mémoire répondant 
aux spécifications suivantes :
Â compatibilité PC-3200 (également appelé DDR-400) ;
Â DDR-SDRAM (Double Data Rate-Synchronous Dynamic Random Access Memory) ;
Â sans tampon et non enregistrée.
La quantité maximale de mémoire pouvant être contenue par votre iMac G5 est de 
2 gigaoctets (Go), via l’insertion de modules de mémoire de 1 Go dans chaque logement. Utilisez Informations Système pour déterminer la quantité de mémoire installée 
sur votre iMac G5. Pour accéder à Informations Système, choisissez Pomme () > 
À propos de ce Mac dans la barre des menus, puis cliquez sur Plus d’infos.
Avertissement : tout dommage causé à votre matériel en tentant d’installer vous-même 
de la mémoire n’est pas couvert par la garantie limitée de votre ordinateur.
F3027Q45C\D.book Page 41 Thursday, April 7, 2005 3:18 PM42 Chapitre 4 Extension des capacités de votre ordinateur
Pour installer un module de mémoire :
1 Éteignez votre ordinateur en choisissant menu Pomme () > Éteindre. Débranchez 
tous les câbles de l’ordinateur, y compris le câble d’alimentation.
2 Placez un linge ou un chiffon propre et doux sur le bureau ou la table. Tout en tenant 
l’ordinateur par les côtés, posez-le lentement à plat afin de faire reposer l’écran contre 
la surface de la table et de tourner le dessous de l’ordinateur vers vous.
3 Soulevez le socle et utilisez un tournevis cruciforme n°1 pour desserrer les trois vis 
imperdables situées sur le dessous de l’ordinateur, en tournant dans le sens contraire 
des aiguilles d’une montre.
· Avertissement : le capteur de lumière intégré se situe sur la gauche de la vis du milieu, 
comme indiqué sur l’illustration. Ne confondez pas le capteur de lumière avec une vis. 
L’introduction d’un tournevis ou de tout autre objet pointu dans le capteur pourrait 
endommager votre ordinateur.
Socle
Tournevis
cruciforme
Dévissez 
ces 3 vis
Vis
Capteur de
lumière intégré
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4 Tout en tenant le socle métallique, faites pivoter le couvercle arrière vers le haut pour 
le soulever de l’ordinateur. Le couvercle arrière attaché au socle doit venir facilement. 
Si ce n’est pas le cas, assurez-vous que les vis sont entièrement dévissées dans le sens 
contraire des aiguilles d’une montre, en veillant à ne pas forcer. 
5 Pour protéger l’ordinateur contre toute décharge d’électricité statique, reliez-vous 
à la terre en touchant la surface métallique à l’intérieur de l’ordinateur.
Avertissement : déchargez-vous toujours de l’électricité statique que vous êtes susceptible d’avoir accumulé avant de toucher ou d’installer tout composant à l’intérieur de 
l’ordinateur. Pour éviter de générer de l’électricité statique, ne vous déplacez pas dans 
la pièce avant d’avoir achevé l’installation de la mémoire et d’avoir refermé l’ordinateur.
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6 Insérez le module de mémoire en angle droit dans son logement et appuyez doucement dessus pour le fixer. Le module ne s’insère dans le logement que dans un seul 
sens. Veillez à aligner les encoches du module avec celles à l’intérieur du logement.
4 1 2 3
iMac 17 pouces
iMac 20 pouces
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7 Tout en tenant le couvercle arrière par le socle, basculez-le légèrement afin d’aligner 
les languettes de son bord supérieur avec les fentes du bord supérieur de l’ordinateur. 
Faites pivoter le couvercle arrière vers le bas et appuyez doucement jusqu’à ce qu’il 
s’ajuste parfaitement sur l’ordinateur. 
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8 Resserrez les trois vis imperdables en les vissant dans le sens des aiguilles 
d’une montre. Veillez à ne pas trop les serrer pour ne pas en abîmer la tête.
9 En tenant l’ordinateur par les côtés, tournez-le doucement afin de le remettre à l’endroit. 
Rebranchez ensuite les câbles et le cordon d’alimentation que vous avez débranchés 
de l’ordinateur.
10 Allumez l’ordinateur en appuyant sur le bouton d’alimentation situé à l’arrière.
· Avertissement : le capteur de lumière intégré se situe sur la gauche de la vis du milieu, 
comme indiqué sur l’illustration. Ne confondez pas le capteur de lumière avec une vis. 
L’introduction d’un tournevis ou de tout autre objet pointu dans le capteur pourrait 
endommager votre ordinateur.
Avertissement : faire fonctionner l’ordinateur lorsqu’il est ouvert ou que certains 
de ses composants ont été enlevés peut s’avérer dangereux ou l’endommager.
Socle
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F3027Q45C\D.book Page 46 Thursday, April 7, 2005 3:18 PMChapitre 4 Extension des capacités de votre ordinateur 47
Vérification de la reconnaissance de la nouvelle mémoire par 
votre ordinateur
Après l’installation de mémoire supplémentaire dans votre iMac G5, vérifiez que l’ordinateur reconnaît bien cette nouvelle mémoire. Procédez de la manière suivante :
1 Démarrez votre ordinateur.
2 Lorsque vous voyez apparaître le bureau Mac OS, choisissez menu Pomme () > 
À propos de ce Mac.
Ce total inclut la quantité de mémoire installée d’origine plus la quantité que vous avez 
ajoutée. Pour une répartition plus détaillée de la quantité de mémoire installée dans 
votre ordinateur, ouvrez Informations Système en cliquant sur Plus d’infos.
Si votre ordinateur ne reconnaît pas la mémoire ou ne démarre pas correctement, 
éteignez-le et vérifiez de nouveau les instructions pour vous assurer que la mémoire 
installée est bien compatible avec cet iMac G5 et qu’elle est correctement installée. 
Si les problèmes persistent, retirez la mémoire et consultez les informations d’assistance technique fournies avec la mémoire ou contactez le fournisseur de la mémoire. 
Mémoire totale 
installée dans votre 
iMac G5
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Remplacement de la pile de secours interne
La pile de secours intégrée à votre iMac G5 permet de conserver certains réglages, 
comme l’heure et la date, quand l’ordinateur est éteint. Si vous avez des problèmes 
pour démarrer votre ordinateur ou que des réglages changent au démarrage, il se 
peut que vous deviez changer la pile de secours interne.
Remarque : si votre ordinateur est branché sur un bloc multiprise, Apple vous 
recommande de laisser ce bloc allumé pour préserver la longévité de votre pile.
Pour remplacer une pile de secours interne dans votre iMac G5 :
1 Éteignez votre ordinateur en choisissant menu Pomme () > Éteindre. Débranchez 
tous les câbles de l’ordinateur, y compris le câble d’alimentation.
2 Placez un linge ou un chiffon propre et doux sur le bureau ou la table. Tout en tenant 
l’ordinateur par les côtés, posez-le lentement à plat afin de faire reposer l’écran contre 
la surface de la table et de tourner le dessous de l’ordinateur vers vous.
3 Soulevez le socle et utilisez un tournevis cruciforme n°1 pour desserrer les trois vis 
imperdables situées sur le dessous de l’ordinateur, en tournant dans le sens contraire 
des aiguilles d’une montre.
· Avertissement : le capteur de lumière intégré se situe sur la gauche de la vis du milieu, 
comme indiqué sur l’illustration. Ne confondez pas le capteur de lumière avec une vis. 
L’introduction d’un tournevis ou de tout autre objet pointu dans le capteur pourrait 
endommager votre ordinateur.
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4 Tout en tenant le socle métallique, faites pivoter le couvercle arrière vers le haut pour 
le soulever de l’ordinateur. Le couvercle arrière attaché au socle doit venir facilement. 
Si ce n’est pas le cas, assurez-vous que les vis sont entièrement dévissées dans le sens 
contraire des aiguilles d’une montre. 
5 Pour protéger l’ordinateur contre toute décharge d’électricité statique, reliez-vous 
à la terre en touchant la surface métallique à l’intérieur de l’ordinateur.
Avertissement : déchargez-vous toujours de l’électricité statique que vous êtes susceptible d’avoir accumulé avant de toucher ou d’installer tout composant à l’intérieur de 
l’ordinateur. Pour éviter de générer de l’électricité statique, ne vous déplacez pas dans 
la pièce avant d’avoir achevé l’installation et d’avoir refermé l’ordinateur.
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6 Pour retirer l’ancienne pile, placez un ongle dans l’encoche, soulevez la pile et glissez-la 
en dehors de la languette métallique.
7 Repérez le côté positif (+) de la nouvelle pile. Glissez la pile sous la languette métallique 
de façon à ce qu’elle touche le côté positif.
Avertissement : l’installation incorrecte de la pile peut provoquer une explosion. 
Assurez-vous de respecter la position des pôles. Utilisez uniquement une pile de type 
identique ou une pile équivalente recommandée par le fabricant de la pile d’origine.
4 1 2 3
Languette métallique
Insérez la nouvelle pile
Encoche
Ôtez l’ancienne pile
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8 Tout en tenant le couvercle arrière par le socle, basculez-le légèrement afin d’aligner 
les languettes de son bord supérieur avec les fentes du bord supérieur de l’ordinateur. 
Faites pivoter le couvercle arrière vers le bas et appuyez doucement jusqu’à ce qu’il 
s’ajuste parfaitement sur l’ordinateur. 
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9 Resserrez les trois vis imperdables en les vissant dans le sens des aiguilles d’une 
montre. Veillez à ne pas trop les serrer pour ne pas en abîmer la tête.
10 En tenant l’ordinateur par les côtés, tournez-le doucement afin de le remettre à 
l’endroit. Rebranchez ensuite les câbles et le cordon d’alimentation que vous avez 
débranchés de l’ordinateur.
11 Allumez l’ordinateur en appuyant sur le bouton d’alimentation situé à l’arrière.
Remarque : le remplacement de la pile peut provoquer le rétablissement des valeurs 
par défaut de certains réglages tels que la date et l’heure. Vous devrez peut-être également restaurer les réglages de modem dans les applications de communication que 
vous utilisez. 
Débarrassez-vous de l’ancienne pile selon les instructions de la section “Disposal and 
Recycling Information” à la page 86.
· Avertissement : le capteur de lumière intégré se situe sur la gauche de la vis du 
milieu, comme indiqué sur l’illustration. Ne confondez pas le capteur de lumière avec 
une vis. L’introduction d’un tournevis ou de tout autre objet pointu dans le capteur 
pourrait endommager votre ordinateur.
Avertissement : faire fonctionner l’ordinateur lorsqu’il est ouvert ou que certains 
de ses composants ont été enlevés peut s’avérer dangereux ou l’endommager.
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5 Dépannage
Il se peut que vous rencontriez à titre exceptionnel des 
problèmes en utilisant votre iMac G5. Dans ce chapitre, 
vous trouverez des suggestions pour résoudre ces 
problèmes.
Ce chapitre apporte des solutions aux problèmes qui vous empêchent de travailler 
avec votre ordinateur, tels que le blocage du système ou de l’ordinateur. Vous trouverez d’autres informations de dépannage dans l’Aide Mac (voir la page 22) et sur 
le site Web Service & Support d’Apple à l’adresse www.apple.com/fr/support.
Lorsque vous rencontrez un problème avec votre ordinateur, sachez qu’il existe généralement une solution simple et rapide. Dans un tel cas, essayez de noter les opérations 
que vous avez effectuées avant que le problème ne survienne. Ce récapitulatif permet 
de restreindre les causes possibles du problème et de trouver la solution. Les éléments 
à noter comprennent :
Â Les applications que vous étiez en train d’utiliser quand le problème est apparu. 
Les problèmes qui n’apparaissent qu’avec une application spécifique peuvent indiquer que cette application n’est pas compatible avec la version de Mac OS installée 
sur votre ordinateur.
Â Tout logiciel installé récemment. Certaines applications installent des extensions 
qui peuvent ne pas être compatibles avec l’environnement Classic.
Â Tout nouveau composant matériel connecté ou installé (mémoire supplémentaire 
ou périphérique, par exemple).
Problèmes vous empêchant d’utiliser votre ordinateur
Si l’ordinateur ne répond pas ou que le pointeur se fige
Â Assurez-vous tout d’abord que la souris et le clavier sont connectés. Débranchez puis 
rebranchez les connecteurs et vérifiez qu’ils sont correctement mis en place. Si vous 
avez un clavier ou une souris sans fil, vérifiez que les piles sont en état de marche.
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Â Si cela ne donne pas de résultats, essayez de forcer la fermeture des applications 
posant problème. Maintenez les touches Option et Commande (x) enfoncées, puis 
appuyez sur Échap. Si une zone de dialogue apparaît, sélectionnez-y l’application 
et cliquez sur Forcer à quitter. Ensuite, enregistrez le travail de toute application 
ouverte, puis redémarrez l’ordinateur afin de vous assurer que le problème est 
entièrement réglé.
Â Si vous ne parvenez pas à forcer la fermeture de l’application, maintenez le bouton 
d’alimentation (®) situé à l’arrière de l’ordinateur enfoncé pour l’éteindre.
Â Si cela reste sans effets, débranchez le câble d’alimentation de l’ordinateur. 
Rebranchez-le, puis appuyez sur le bouton d’alimentation (®) de l’ordinateur 
pour le rallumer.
Si le problème survient fréquemment lorsque vous utilisez une application particulière, 
consultez le fabricant de cette dernière pour vérifier si elle est compatible avec votre 
ordinateur.
Pour l’assistance et les informations de contact relatives aux logiciels fournis avec votre 
ordinateur, rendez-vous sur www.apple.com/guide.
Si le problème se reproduit fréquemment, réinstallez éventuellement votre logiciel 
système (voir “Réinstallation des logiciels fournis avec votre ordinateur” à la page 55).
Si l’ordinateur se bloque lors du démarrage ou si un point d’interrogation 
clignote à l’écran
Â Patientez quelques secondes. Si l’ordinateur ne démarre pas après un certain temps, 
éteignez-le en maintenant le bouton d’alimentation (®) enfoncé pendant 5 secondes, 
jusqu’à ce qu’il s’éteigne complètement. Maintenez ensuite la touche Option enfoncée, 
puis appuyez de nouveau sur le bouton d’alimentation (®) pour démarrer votre ordinateur. Lorsque votre ordinateur démarre, cliquez sur l’icône du disque dur, puis sur 
la flèche droite.
Â Une fois que l’ordinateur a démarré, ouvrez Préférences Système et cliquez 
sur Démarrage. Sélectionnez un dossier Système Mac OS X.
Â Si le problème se reproduit fréquemment, réinstallez éventuellement votre logiciel 
système (voir “Réinstallation des logiciels fournis avec votre ordinateur” à la page 55).
Si l’ordinateur ne s’allume pas ou ne démarre pas
Â Assurez-vous que le câble d’alimentation est connecté à l’ordinateur et branché 
sur une prise électrique en état de marche. 
Â Si le problème persiste, appuyez sur le bouton d’alimentation (®) et maintenez 
enfoncées les touches Commande (x), Option, P et R jusqu’à entendre une seconde 
fois le signal de démarrage. 
Â Si vous avez récemment ajouté de la mémoire, assurez-vous qu’elle est correctement 
installée et compatible avec votre ordinateur. Vérifiez si son retrait permet à l’ordinateur de démarrer (voir la page 41).
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Â Si cela reste sans effet, débranchez le câble d’alimentation et attendez au moins 30 
secondes. Rebranchez-le, puis appuyez de nouveau sur le bouton d’alimentation (®) 
de l’ordinateur pour le rallumer. 
Â Si vous ne réussissez toujours pas à démarrer, consultez les informations sur 
les options de services et d’assistance fournies avec votre iMac G5 pour savoir 
comment contacter Apple.
Réinstallation des logiciels fournis avec votre ordinateur
Les disques d’installation de logiciels fournis avec votre ordinateur permettent de réinstaller Mac OS X et les applications livrées avec votre ordinateur, et d’installer Mac OS 9.
Important : Apple vous recommande de sauvegarder les données de votre disque dur 
avant de procéder à la restauration du logiciel. Apple décline toute responsabilité en 
cas de perte de données.
Installation de Mac OS X
Pour installer Mac OS X :
1 Sauvegardez vos fichiers importants si cela est possible.
2 Insérez le “Mac OS X Install Disk 1” livré avec votre ordinateur.
3 Double-cliquez sur “Install Mac OS X and Bundled Software”.
4 Suivez les instructions à l’écran.
5 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions à l’écran. Il se peut que votre ordinateur redémarre et vous demande d’insérer 
le prochain disque d’installation de Mac OS X.
Important : nous vous conseillons de sauvegarder vos fichiers importants avant d’installer 
Mac OS X et les autres applications car l’option “Effacer et installer” efface votre disque 
de destination.
Installation des applications
Pour installer les applications fournies avec votre ordinateur, veuillez procéder comme 
suit. Mac OS X doit déjà être installé sur votre ordinateur. 
Pour installer Mac OS X :
1 Sauvegardez vos fichiers importants si cela est possible.
2 Insérez le “Mac OS X Install Disk 1” livré avec votre ordinateur.
3 Double-cliquez sur “Install Bundled Software Only.”
4 Suivez les instructions à l’écran.
5 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran. 
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Remarque : pour installer iCal, iChat AV, iSync, iTunes et Safari, suivez les instructions 
“Installation de Mac OS X” en page précédente.
Installation de Mac OS 9
À la livraison de votre iMac G5, Mac OS 9 n’est pas installé. Pour utiliser les applications 
Mac OS 9 avec votre ordinateur, vous devez installer Mac OS X à partir du disque 
d’installation 2 de Mac OS X.
Pour installer Mac OS 9 : 
1 Sauvegardez vos fichiers importants si cela est possible.
2 Insérez le “Mac OS X Install Disk 2” livré avec votre ordinateur.
3 Double-cliquez sur “Install Mac OS 9 System Support”.
4 Suivez les instructions à l’écran.
5 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran. 
Autres problèmes
En cas de problème avec une application
Â Pour les problèmes liés aux logiciels provenant d’éditeurs tiers, contactez l’éditeur 
concerné. Les éditeurs de logiciels proposent souvent des mises à jour de leurs 
produits sur leurs sites Web. Vous pouvez utiliser la sous-fenêtre Mise à jour de logiciels des Préférences Système pour configurer votre iMac G5 afin qu’il recherche 
et installe automatiquement les derniers logiciels Apple. Pour plus d’informations, 
choisissez Aide > Aide Mac, puis recherchez “mise à jour de logiciels”.
En cas de problèmes avec les communications sans fil AirPort
Â Vérifiez que vous avez correctement configuré le logiciel en respectant les instructions 
fournies avec la borne d’accès AirPort Extreme ou AirPort Express.
Â Vérifiez que l’ordinateur ou le réseau auquel vous souhaitez vous connecter est 
activé et dispose d’un point d’accès sans fil.
Â Assurez-vous que l’autre ordinateur ou le point d’accès au réseau se trouve dans 
la zone de couverture de l’antenne de votre ordinateur. Des appareils électroniques 
ou des structures métalliques se trouvant à proximité peuvent interférer avec les 
communications sans fil et réduire la portée de votre antenne. Vous pouvez éventuellement améliorer la réception en réorientant l’ordinateur.
Â Vérifiez la puissance du signal AirPort. L’icône d’état AirPort de la barre des menus 
affiche jusqu’à quatre barres.
Â Des problèmes de fonctionnement de réseau peuvent survenir si votre borne d’accès 
est fréquemment utilisée à proximité d’un four micro-ondes, d’un téléphone sans fil 
ou autres sources d’interférences. Pour minimiser les interférences, placez votre borne 
d’accès loin de ces appareils.
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Â Pour plus d’informations sur l’utilisation et le dépannage de AirPort, sélectionnez 
Aide > Aide Mac, puis choisissez Centre d’aide > Aide AirPort.
En cas de problèmes avec l’éjection d’un disque
Â Quittez toutes les applications susceptibles de solliciter le disque et appuyez 
sur la touche d’éjection de disque (C) de votre clavier.
Â Si cela ne fonctionne pas, ouvrez une fenêtre du Finder et cliquez sur l’icône d’éjection à côté de celle de disque dans la barre latérale ou faites glisser l’icône du disque 
du bureau jusqu’à la Corbeille.
Â Si cela ne donne pas de résultats, redémarrez l’ordinateur tout en maintenant 
le bouton de la souris enfoncé.
En cas de problèmes de connexion à Internet
Â Assurez-vous que votre ligne téléphonique ou que votre câble réseau est connecté 
et qu’il fonctionne correctement.
Â Si vous utilisez une connexion Internet par appel commuté, vérifiez que votre câble 
téléphonique est relié au port modem (représenté par le symbole W) et non au port 
Ethernet (symbole G).
Â Consultez “Connexion à Internet” à la page 67 pour en savoir plus sur la configuration de votre ordinateur en vue de la connexion à Internet. Vous y découvrirez 
comment localiser vos réglages Internet ainsi que les coordonnées de votre fournisseur d’accès à Internet (si vous vous êtes servi de l’Assistant réglages pour établir 
votre compte Internet).
Â Consultez “Dépannage de votre connexion” à la page 83 en cas de problème de 
connexion à Internet.
En cas de problèmes de fonctionnement de votre ordinateur ou de Mac OS
Â Si les réponses à vos questions ne figurent pas dans ce manuel, recherchez des 
instructions et des informations de dépannage dans l’Aide Mac. Dans le Finder, 
choisissez Aide > Aide Mac.
Â Pour obtenir les dernières informations de dépannage et des mises à jour de logiciels, consultez le site Web d’assistance Apple, à l’adresse www.apple.com/fr/support.
Si vos réglages de date et heure disparaissent régulièrement
Â La pile de secours interne de votre ordinateur a peut-être besoin d’être remplacée. 
Pour toute information supplémentaire, consultez la section “Remplacement de la 
pile de secours interne” à la page 48.
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Localisation du numéro de série de votre produit
Le numéro de série de votre iMac G5 est apposé sous son socle. Vous le trouverez 
également dans les Informations Système. Pour y accéder, choisissez Pomme () > 
À propos de ce Mac dans la barre de menus, puis cliquez sur Plus d’infos. Cliquez sur 
le triangle Matériel pour afficher le numéro de série.
Utilisation de Apple Hardware Test
Apple Hardware Test vous aide à déterminer s’il existe un problème matériel sur votre 
ordinateur. 
Pour utiliser Apple Hardware Test :
1 Déconnectez tous les périphériques de votre ordinateur sauf le clavier et la souris. 
Si un câble Ethernet est connecté, déconnectez-le.
2 Insérez le “Mac OS X Install Disk 1” livré avec votre ordinateur. 
3 Puis redémarrez votre ordinateur en maintenant la touche Option enfoncée lors 
du démarrage. 
4 Cliquez sur Apple Hardware Test lorsque la liste des volumes de démarrage 
disponibles apparaît. 
5 Cliquez sur la flèche droite.
6 Lorsque l’écran principal Apple Hardware Test apparaît (environ 45 secondes plus tard), 
suivez les instructions affichées à l’écran.
7 En cas de détection d’un problème, Apple Hardware Test affiche un code d’erreur. 
Notez le code d’erreur avant d’entreprendre les démarches d’assistance. Si Apple Hardware Test ne détecte pas de panne matérielle, il est probable que le problème soit lié 
aux logiciels.
Pour en savoir plus sur Apple Hardware Test, consultez le fichier Ouvrez-moi d’Apple 
Hardware Test situé sur le “Mac OS X Install Disk 1”.
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A Annexe
A Caractéristiques
Vous pouvez utiliser Informations Système pour trouver 
des informations détaillées sur votre iMac G5, telles que 
la quantité de mémoire intégrée, la taille du disque dur, les 
périphériques connectés et le numéro de série du produit.
Pour accéder aux Informations Système, choisissez Pomme () > À propos de ce Mac 
dans la barre de menus, puis cliquez sur Plus d’infos.
Pour plus d’informations, vous pouvez consulter les sites Internet 
www.apple.com/fr/iMac et www.apple.com/fr/support.
Dans la fenêtre
apparaissant, cliquez sur
les triangles pour
afficher ou cacher le
contenu des différentes
catégories.
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B Annexe
B Consignes d’entretien, 
d’utilisation et de sécurité
Afin d’assurer votre propre sécurité et de préserver votre 
matériel, veillez à observer les consignes exposées dans 
cette annexe pour le nettoyage et la manipulation de 
votre ordinateur, ainsi que l’aménagement d’un espace 
de travail confortable.
Nettoyage de votre iMac G5
Respectez les règles suivantes lors du nettoyage de votre ordinateur et de ses 
accessoires :
• Éteignez votre iMac G5 et débranchez tous les câbles.
• Pour nettoyer le boîtier de l’ordinateur, utilisez un chiffon doux, humide et non 
pelucheux. Évitez les infiltrations d’humidité par quelque ouverture que ce soit. 
Ne vaporisez jamais de liquide directement sur l’ordinateur.
• N’utilisez ni aérosols, ni dissolvant, ni abrasifs.
Nettoyage de l’écran de votre iMac G5
Pour nettoyer l’écran de votre iMac G5, procédez comme suit :
• Éteignez votre iMac G5 et débranchez tous les câbles.
• Humidifiez, à l’eau seulement, un chiffon propre, doux et non pelucheux et essuyez 
l’écran. Ne vaporisez jamais de liquide directement sur l’écran.
Transport de votre iMac G5
Avant de soulever ou de repositionner votre ordinateur, vous devez débrancher tous 
les câbles et les prises qui y sont connectés.
Pour soulever ou déplacer l’ordinateur, tenez-le par les côtés.
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Consignes de sécurité pour la configuration et l’utilisation 
de votre ordinateur
Pour votre propre sécurité et celle de votre matériel, respectez toujours les consignes 
suivantes. 
Débranchez le câble d’alimentation (en tirant sur la fiche plutôt que sur le câble) 
et le câble téléphonique si l’un des cas suivants se présente :
• Vous souhaitez retirer un composant quelconque.
• Le câble ou la fiche d’alimentation est usé(e) ou endommagé(e).
• Vous avez renversé quelque chose dans le boîtier de l’ordinateur.
• Votre ordinateur est exposé à la pluie ou à une humidité excessive.
• Votre ordinateur est tombé ou son boîtier a été endommagé de quelque autre façon.
• Votre ordinateur doit être inspecté ou réparé.
• Vous devez nettoyer le boîtier (pour ce faire, suivez à la lettre les instructions fournies 
précédemment).
Important : la seule manière de couper complètement l’alimentation de l’ordinateur 
consiste à débrancher le câble d’alimentation et le câble téléphonique. Assurez-vous 
qu’au moins une extrémité du câble d’alimentation se trouve à portée de main afin 
de pouvoir débrancher l’ordinateur si nécessaire.
Observez toujours les consignes ci-dessous :
• Évitez de placer votre ordinateur à proximité d’un évier, d’un lavabo, d’une baignoire, 
d’une douche, etc.
• Protégez votre ordinateur de l’humidité et des intempéries (neige, pluie...).
• Lisez soigneusement les instructions d’installation avant de brancher votre 
ordinateur sur une prise murale.
• Gardez ces instructions dans un endroit facile d’accès pour vous et pour 
les utilisateurs éventuels.
• Suivez toutes les instructions et mises en garde concernant votre système.
Avertissement : votre cordon d’alimentation CA est livré avec une fiche de terre à trois 
broches (fiche équipée d’une troisième broche de mise à la terre). Cette fiche ne peut 
être branchée que sur une prise CA reliée à la terre. Si vous ne pouvez pas brancher la 
fiche parce que la prise n’est pas reliée à la terre, contactez un électricien agréé pour 
qu’il remplace cette dernière par une prise reliée à la terre. Ne dérogez en aucun cas 
à cette consigne.
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Important : le matériel électrique peut s’avérer dangereux s’il n’est pas utilisé 
correctement. L’utilisation de ce produit ou de tout produit similaire doit toujours être 
supervisée par un adulte. Ne permettez pas aux enfants de toucher les composants 
internes de tout appareil électrique, ni de manipuler des câbles électriques.
Connecteurs et ports
Ne forcez jamais un connecteur dans un port. Si vous ne parvenez pas à brancher le 
connecteur sur le port sans forcer, c’est qu’ils ne sont pas adaptés. Assurez-vous que le 
connecteur est adapté au port et que vous l’avez positionné correctement par rapport 
à ce dernier.
Prévention des dommages auditifs
Avertissement : n’introduisez jamais d’objets d’aucune sorte dans les ouvertures 
du boîtier. Cela peut être dangereux et provoquer un incendie ou un choc électrique.
Avertissement : l’utilisation d’écouteurs ou de casques d’écoute réglés sur un niveau 
de volume trop élevé peut entraîner une perte durable de l’acuité auditive. Il est 
possible de supporter petit à petit des volumes sonores de plus en plus élevés qui 
peuvent sembler normaux à la longue, mais qui risquent néanmoins d’endommager 
votre ouïe. Réglez le volume de votre iMac G5 à un niveau normal avant que le 
problème ne survienne. En cas de bourdonnements dans les oreilles, baissez le 
volume ou cessez d’utiliser les écouteurs ou le casque d’écoute avec votre iMac G5.
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Ergonomie
Siège
Optez pour un siège de bureau réglable et offrant un dossier et une assise confortables. 
Réglez la hauteur du siège de sorte que vos cuisses reposent à l’horizontale et vos pieds 
à plat sur le sol. Le dossier du siège doit soutenir votre région lombaire, c’est-à-dire la 
partie inférieure de votre dos. Suivez les instructions du fabricant de sorte que le réglage 
du dossier soit parfaitement adapté à votre morphologie.
Au besoin, relevez le siège de manière à ce que vos avant-bras et vos mains soient 
placés correctement par rapport au clavier. Si, dans ce cas, vos pieds ne reposent plus 
à plat sur le sol, utilisez un repose-pied inclinable et réglable en hauteur. Vous pouvez 
également abaisser le niveau du plan de travail pour éviter l’emploi d’un repose-pied. 
Une troisième solution consiste à utiliser un bureau dont le poste de saisie est situé 
plus bas que le plan de travail.
Écran
Placez le moniteur de manière à ce que le haut de l’écran soit légèrement en dessous 
du niveau de vos yeux quand vous êtes assis au clavier. Il vous appartient de juger de 
la meilleure distance entre vos yeux et l’écran. Elle se situe en général entre 45 et 70 cm.
Orientez l’écran de manière à ce qu’il reflète le moins possible la lumière provenant 
de l’éclairage et des fenêtres.
Souris
Veillez à ce que la souris se trouve à hauteur du clavier. Ménagez un espace suffisant 
pour la manipuler avec aisance..
Cuisses légèrement 
inclinées
Épaules détendues
Écran positionné de façon
à éviter tout reflet éblouissant
Avant-bras et mains
en ligne droite
Avant-bras 
légèrement inclinés
Bas du dos soutenu
Pieds fixes au sol
ou sur un repose-pied
Haut de l'écran au niveau des yeux ou juste
en dessous (Il se peut que vous deviez ajuster
la hauteur de votre écran en élevant ou en
rabaissant votre plan de travail.)
Côté inférieur au plan de travail dégagé
45–70 cm
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Clavier
Veillez à maintenir vos épaules relâchées lorsque vous utilisez le clavier. Le bras et 
l’avant-bras doivent former un angle droit, la main étant placée dans le prolongement 
du poignet.
Adoptez une frappe légère avec les mains et les doigts détendus. Évitez de replier 
les pouces à l’intérieur des paumes.
Modifiez fréquemment la position de vos mains pour éviter la fatigue. Après un effort 
continu et intensif, certains utilisateurs ressentent des douleurs aux mains, aux poignets 
ou aux bras. Si ces douleurs persistent, consultez un spécialiste.
Pour plus d’informations
Rendez-vous sur le site Web www.apple.com/about/ergonomics.
Apple et l’environnement
Apple Computer, Inc. reconnaît sa responsabilité en matière de réduction de l’impact 
de ses produits et de ses activités sur l’environnement.
Pour plus d’informations
Rendez-vous sur le site www.apple.com/environment/summary.html.
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C Annexe
C Connexion à Internet
Votre ordinateur vous permet de naviguer sur le Web, 
d’échanger du courrier électronique avec vos amis et 
votre famille ou de dialoguer en temps réel via Internet. 
Suivez les instructions de ce guide détaillé pour vous 
connecter à Internet.
Lors du premier démarrage de Mac OS X, l’Assistant réglages vous aide à saisir 
vos informations de configuration Internet.
Si vous n’avez pas utilisé l’Assistant réglages pour configurer votre connexion à Internet, 
vous pouvez l’utiliser maintenant. Ouvrez Préférences Système, puis cliquez sur Réseau. 
Cliquez sur le bouton “Assistez-moi” pour ouvrir l’Assistant réglages de réseau. Si vous 
ne souhaitez pas utiliser cet Assistant, vous pouvez réaliser votre connexion manuellement 
à l’aide des informations données dans cette annexe.
Il existe quatre types de connexion à Internet :
• Connexion par ligne téléphonique : l’ordinateur est relié à une prise téléphonique 
murale via un câble téléphonique (pour les ordinateurs comprenant un modem).
• Connexion à haut débit via un modem câble ou DSL : l’ordinateur est relié via 
un câble Ethernet à un modem spécial fourni par un FAI.
• Connexion sans fil AirPort Extreme : l’ordinateur est connecté sans fil à Internet 
via une borne d’accès Airport Extreme ou AirPort Express.
• Réseau local (LAN) : l’ordinateur est connecté à un réseau local via un câble 
Ethernet. C’est le type de connexion habituellement utilisé dans les entreprises.
Avant de vous connecter à Internet :
1 Procurez-vous un compte auprès d’un FAI si vous n’en possédez pas encore. Vous 
pouvez consulter votre annuaire téléphonique pour trouver un fournisseur d’accès 
à Internet. Consultez les rubriques “accès Internet”, “services Internet” ou “en ligne”.
Remarque : si vous choisissez America Online, sautez l’étape Réglages Internet de 
l’Assistant réglages. Vous devez utiliser le programme d’installation d’AOL. Ouvrez 
ce programme, puis suivez les instructions à l’écran pour configurer AOL.
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2 Procurez-vous les informations de connexion auprès de votre FAI ou de votre 
administrateur réseau. Consultez la section “Fiche technique Assistant réglages” à la 
page 69 pour savoir quelles sont les informations dont vous avez besoin pour chaque 
type de connexion. 
Dans certains cas, si un autre ordinateur se trouvant au même emplacement est déjà 
connecté à Internet, vous pouvez probablement utiliser ses réglages. 
Pour accéder aux réglages sur un ordinateur Mac OS X :
• Ouvrez la sous-fenêtre Réseau des Préférences Système.
• Dans le menu local Afficher, sélectionnez votre mode de connexion. 
• Copiez les informations concernant votre connexion.
Pour accéder aux réglages sur un ordinateur Mac OS 9 :
• Ouvrez le tableau de bord TCP/IP.
• Rechercher le mode de connexion dans le menu local “Connexion”.
• Recherchez la configuration dans le menu local Configurer.
• Notez l’adresse IP, le masque de sous-réseau et l’adresse du routeur figurant 
dans les champs correspondants.
Pour accéder aux réglages sur un PC Windows :
Les informations de connexion d’un PC Windows se trouvent à deux endroits.
• Pour trouver l’adresse IP et le masque de sous-réseau, ouvrez le tableau de bord 
“Connexions réseau et Internet”.
• Pour accéder aux informations relatives aux comptes d’utilisateurs, ouvrez le tableau 
de bord Comptes d’utilisateurs. 
Vous pouvez écrire ces informations directement sur les pages suivantes, puis les saisir 
dans l’Assistant réglages.
3 Si vous utilisez un modem téléphonique, branchez un câble téléphonique (inclus avec 
la plupart des ordinateurs Macintosh) sur le port modem de votre ordinateur et sur une 
prise téléphonique murale. Si vous disposez d’un modem DSL ou câble, connectez-le à 
votre ordinateur en suivant les instructions incluses. 
4 Allumez votre ordinateur et saisissez les informations dans l’Assistant réglages pour 
configurer votre connexion à Internet.
Remarque : si vous avez déjà démarré votre ordinateur et configuré votre connexion à 
Internet sans utiliser l’Assistant réglages, sélectionnez Pomme () > Préférences Système 
et cliquez sur Réseau. Puis cliquez sur “Assistez-moi”. L’Assistant réglages s’ouvre.
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Fiche technique Assistant réglages
Vous pouvez noter sur ces pages les informations obtenues auprès de votre 
Fournisseur d’Accès à Internet (FAI), de votre administrateur réseau ou de votre 
autre ordinateur, puis les saisir dans l’Assistant réglages de réseau.
Sélectionnez la méthode utilisée par votre ordinateur pour se connecter 
à Internet.
Pour configurer une connexion par ligne commutée, entrez les informations 
suivantes :
Pour configurer une connexion par modem câble ou DSL, ou via un 
réseau local :
1 Choisissez votre type de connexion. Renseignez-vous auprès de votre FAI.
Modem téléphonique
Modem câble
Modem DSL
Réseau local (Ethernet)
Sans fil
Nom d’utilisateur
Mot de passe
Numéro de téléphone FAI
Préfixe pour obtenir la ligne externe
Manuellement
Utilisation de DHCP avec une adresse manuelle
Via DHCP
Via BootP
PPP
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2 Saisissez les informations fournies par votre FAI :
Si vous avez sélectionné “Manuellement” ou “Utilisation de DHCP avec 
une adresse manuelle”*, saisissez les informations suivantes :
* Si vous avez sélectionné “Utilisation de DHCP avec une adresse manuelle”, il n’est pas nécessaire de saisir un masque 
de réseau ou une adresse de routeur.
Si vous avez sélectionné “Via DHCP”, saisissez :
Remarque : le numéro de client DHCP est facultatif et il est possible qu’il ne soit 
pas nécessaire. Demandez conseil à votre FAI.
Si vous avez sélectionné “PPP (pour les connexions PPPoE)”, saisissez :
Adresse IP
Masque de sous-réseau
Adresse du routeur
Numéro de client DHCP
Fournisseur d’accès (facultatif)
Nom de service PPPoE (facultatif)
Nom de compte
Mot de passe
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Les informations ci-après sont facultatives. Demandez à votre FAI 
s’il est nécessaire de les saisir.
Configuration manuelle de votre connexion à Internet
Lorsque vous avez accompli, à l’aide de l’Assistant réglages, les instructions des pages 
précédentes, vous avez terminé la configuration de votre connexion à Internet. Si vous 
ne souhaitez pas utiliser l’Assistant réglages ou si vous souhaitez simplement modifier 
des parties spécifiques de votre configuration Internet, suivez les instructions suivantes 
pour configurer manuellement votre connexion.
Pour saisir vos informations manuellement, suivez les étapes correspondant à votre 
mode de connexion.
• Modem téléphonique avec connexion PPP (Point-to-Point Protocol) (reportez-vous 
à la page 71)
• Connexion par modem câble, ligne DSL ou réseau LAN avec les configurations 
suivantes :
• Manuelle (reportez-vous à la page 76)
• DHCP (reportez-vous à la page 77)
• PPPoE (reportez-vous à la page 78)
• Connexion sans fil AirPort (reportez-vous à la page 80)
Connexion commutée
Le modem téléphonique constitue la manière la plus courante de se connecter à 
Internet. Votre modem utilise une méthode appelée PPP (Point-to-Point Protocol) 
pour se connecter à un FAI.
Assurez-vous que votre modem est branché sur une ligne téléphonique et que 
vous disposez des informations fournies par votre FAI (reportez-vous à la page 69).
Hôtes DNS (facultatif pour DHCP & BootP)
Nom de domaine (facultatif)
Serveur proxy (facultatif)
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Pour configurer les préférences Réseau pour le port modem interne : 
1 Choisissez Pomme () > Préférences Système dans la barre des menus. 
2 Cliquez sur Réseau.
3 Choisissez Configuration des ports réseau dans le menu local Afficher, puis cochez 
la case Activé à côté de Modem interne.
4 Faites glisser Modem interne en haut de la liste Configurations de port pour en faire 
l’interface réseau préférée ou principale.
5 Choisissez Modem interne dans le menu local Afficher et cliquez sur PPP. 
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6 Saisissez les informations fournies par votre FAI, puis cliquez sur Appliquer. 
Pour tester votre configuration Internet :
1 Ouvrez l’application Connexion à Internet (dans le dossier Applications).
2 Cliquez sur l’icône Modem interne si nécessaire.
3 Tapez le numéro de téléphone de connexion de votre FAI, votre nom de compte 
et votre mot de passe, si nécessaire.
4 Cliquez sur Se connecter.
L’application Connexion à Internet compose le numéro de votre FAI et établit 
une connexion.
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Pour vous connecter automatiquement au démarrage d’une application Internet, 
telle qu’un navigateur Web ou une application de courrier électronique :
1 Cliquez sur Options PPP (dans la sous-fenêtre PPP des préférences Réseau).
2 Cochez la case “Se connecter automatiquement si nécessaire”.
3 Cliquez sur OK, puis sur Appliquer. 
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Connexions à Internet par ligne DSL, modem câble ou 
réseau LAN
Si vous vous connectez à Internet soit à l’aide d’un modem DSL ou câble, soit via un 
réseau LAN Ethernet, demandez à votre FAI ou à votre administrateur réseau comment 
vous devriez configurer votre connexion à Internet :
• Manuellement : avec une configuration manuelle, votre FAI ou votre administrateur 
réseau vous communique une adresse IP statique et d’autres informations à saisir 
dans les préférences Réseau.
• Utilisation du protocole DHCP (Dynamic Host Configuration Protocol) : avec une 
configuration DHCP, le serveur DHCP saisit automatiquement les informations à votre 
place.
• Utilisation du protocole PPPoE (Point-to-Point Protocol over Ethernet) : si vous 
utilisez un modem DSL et que vous avez besoin d’un nom d’utilisateur et d’un mot 
de passe pour vous connecter à Internet, vous devrez éventuellement configurer 
votre réseau pour qu’il utilise le protocole PPPoE.
Lors de la configuration de votre réseau, veillez à garder les informations fournies 
par votre FAI à portée de main (reportez-vous à la page 69).
Pour configurer les préférences Réseau pour le port Ethernet intégré :
1 Choisissez Pomme () > Préférences Système dans la barre des menus.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez Configurations de ports réseau.
4 Cochez la case Activé à côté d’Ethernet intégré.
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5 Faites glisser Ethernet intégré en haut de la liste Configurations de port pour en faire 
l’interface réseau préférée ou principale. 
Suivez ensuite les instructions de configuration manuelle de votre réseau, via DHCP 
ou PPPoE, selon les recommandations de votre FAI ou de votre administrateur réseau.
Configuration manuelle
Ayez à portée de main votre adresse IP statique, l’adresse du routeur et le masque 
de sous-réseau fournis par votre FAI (reportez-vous à la page 69).
Pour effectuer une configuration manuelle : 
1 Dans préférence Réseau, sélectionnez Ethernet intégré dans le menu local Afficher.
2 Cliquez sur TCP/IP, si nécessaire.
3 Dans le menu local Configurer IPv4, choisissez Manuellement.
4 Remplissez le reste des champs. 
5 Cliquez sur Appliquer.
Votre connexion est prête dès que vous avez configuré votre réseau. Ouvrez votre 
navigateur Web (ou une autre application TCP/IP) afin de tester votre connexion 
à Internet.
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Configuration DHCP
Après avoir choisi une configuration DHCP, le serveur DHCP fournit automatiquement 
vos informations de réseau.
Pour effectuer une configuration DHCP :
1 Dans préférence Réseau, sélectionnez Ethernet intégré dans le menu local Afficher.
2 Cliquez sur TCP/IP, si nécessaire.
3 Choisissez Via DHCP dans le menu local Configurer IPv4.
4 Cliquez sur Appliquer.
Ouvrez votre navigateur Web (ou une autre application TCP/IP) afin de tester votre 
connexion à Internet.
Remarque : sauf instructions contraires de votre FAI, ignorez les champs Client DHCP 
et Domaines de recherche.
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Configuration PPPoE
Certains FAI recourant à la technologie DSL utilisent le protocole PPPoE (Point-to-Point 
Protocol over Ethernet)). Si vous utilisez un modem DSL et que vous avez besoin d’un 
nom d’utilisateur et d’un mot de passe pour vous connecter à Internet, contactez votre 
FAI pour savoir si vous devez vous connecter via PPPoE. 
Pour configurer une connexion PPPoE :
Pour configurer votre réseau, ayez à portée de main votre nom d’utilisateur, votre mot 
de passe et, si cela est nécessaire, l’adresse du serveur de noms de domaine (DNS) fournis 
par votre FAI (reportez-vous à la page 69).
1 Dans préférence Réseau, sélectionnez Ethernet intégré dans le menu local Afficher.
2 Cliquez sur PPPoE et sélectionnez “Se connecter via PPPoE”.
3 Remplissez le reste des champs. Si vous souhaitez que tous les utilisateurs de votre 
ordinateur utilisent la même méthode de connexion, sélectionnez “Enregistrer le mot 
de passe”.
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Remarque : pour vous connecter automatiquement au démarrage d’une application 
TCP/IP, par exemple un navigateur Web ou une application de courrier électronique, 
cliquez sur Options PPPoE, sélectionnez “Se connecter automatiquement si nécessaire”, 
puis cliquez sur OK.
4 Cliquez sur TCP/IP et sélectionnez Via PPP ou Manuellement dans le menu local 
Configurer IPv4, selon les instructions de votre FAI. Si votre FAI vous a communiqué 
une adresse IP statique, choisissez Manuellement et tapez l’adresse dans le champ 
Adresse IP.
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5 Saisissez les adresses des serveurs de noms de domaine (DNS) dans le champ 
Serveurs DNS.
6 Cliquez sur Appliquer.
Votre connexion à Internet est prête dès que vous avez configuré votre réseau. 
Vous pouvez alors ouvrir votre navigateur Web ou une autre application TCP/IP 
afin de tester votre connexion.
Important : si vous n’avez pas sélectionné l’option de connexion automatique, vous 
devez ouvrir l’application Connexion à Internet, choisir la configuration adéquate, puis 
cliquer sur Se connecter. Pour plus d’informations, choisissez Aide > Aide Connexion 
à Internet dans la barre des menus située en haut de l’écran. 
Connexion sans fil AirPort
Si une carte AirPort Extreme est installée sur votre iMac G5, vous pouvez configurer 
votre réseau AirPort et votre connexion à Internet à l’aide de l’Assistant réglages AirPort 
qui se trouve dans le dossier Applications/Utilitaires. L’assistant vous aide à configurer 
votre borne d’accès AirPort et à régler votre ordinateur pour qu’il utilise AirPort. Pour 
en savoir plus sur votre borne d’accès AirPort, consultez le guide fourni avec le matériel.
Si votre borne d’accès AirPort est déjà configurée, votre carte AirPort Extreme peut 
dans la plupart des cas y accéder immédiatement. 
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Pour vérifier si vous avez accès à un réseau AirPort :
m
Cliquez sur l’icône d’état AirPort dans la barre des menus et choisissez un réseau 
AirPort dans la liste.
Si aucun réseau AirPort n’y figure, vous pouvez utiliser l’Assistant réglages AirPort 
pour vérifier ou modifier vos réglages ou bien les changer via la sous-fenêtre “Réseau 
des Préférences Système”. 
Configuration manuelle d’une connexion AirPort
Demandez les informations suivantes à votre administrateur système si vous prévoyez 
d’effectuer une connexion manuelle. 
Si vous vous connectez via DHCP, la plupart de ces informations sont automatiquement 
transmises à votre ordinateur via le réseau. Consultez votre administrateur de système 
pour obtenir les renseignements nécessaires.
• Adresses des serveurs de noms de domaine (DNS), si nécessaire
• Configuration d’adresse IP manuelle ou via DHCP
• Adresse IP 
• Adresse du routeur 
• Masque de sous-réseau
• Mot de passe, si nécessaire
Assurez-vous ensuite que les options de connexion AirPort sont activées dans les 
préférences Réseau.
Pour configurer les Préférences réseau pour une connexion AirPort :
1 Choisissez Pomme () > Préférences Système dans la barre des menus.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez “Configurations de ports réseau”.
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4 Cochez la case Activé à côté d’AirPort.
Suivez ensuite les instructions fournies par votre FAI ou votre administrateur réseau 
pour configurer votre réseau manuellement ou via DHCP. Si vous configurez vousmême votre réseau, il est peut-être plus simple d’utiliser DHCP car le serveur attribue 
automatiquement les adresses IP.
5 Choisissez AirPort dans le menu local Afficher.
6 Cliquez sur TCP/IP, si nécessaire.
7 Dans le menu local Configurer IPv4, choisissez Manuellement ou Via DHCP.
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• Si vous choisissez Manuellement, saisissez les autres informations dans les champs 
correspondants. 
• Si vous choisissez Via DHCP, il est inutile de saisir d’autres informations, sauf instructions 
contraires de votre administrateur de système.
8 Cliquez sur AirPort et sélectionnez les options requises pour vous connecter à un 
réseau AirPort Extreme après le redémarrage ou lors de la réactivation de l’ordinateur 
après une suspension d’activité.
9 Cliquez sur Appliquer.
Une fois les réglages AirPort configurés, vous êtes prêt à vous connecter.
Pour tester votre connexion AirPort :
m
Cliquez sur l’icône d’état AirPort dans la barre des menus et choisissez Activer AirPort.
Tout réseau AirPort Extreme situé dans la zone de couverture doit apparaître dans 
le menu.
Dépannage de votre connexion
Connexion à Internet par modem câble, DSL et réseau LAN
SI vous n’arrivez pas à vous connecter à Internet avec votre AirPort, votre interface 
Ethernet intégrée ou votre modem interne, vous pouvez recourir au Diagnostic réseau 
pour obtenir un état sur vos problèmes de connexion. Dans la sous-fenêtre Réseau 
des Préférences Système, cliquez sur Assistant, puis sur Diagnostic pour ouvrir le 
Diagnostic réseau puis suivez les instructions.
Si Diagnostic réseau n’est pas en mesure de résoudre le problème, celui-ci se situe 
peut-être au niveau du fournisseur d’accès à Internet (FAI) auquel vous essayez de 
vous connecter, du périphérique externe utilisé pour la connexion au FAI ou du serveur 
auquel vous essayez d’accéder. Vous pouvez également tenter de suivre les étapes 
suivantes :
Vérifiez les câbles et les sources d’alimentation
Assurez-vous que tous les câbles du modem sont correctement branchés, y compris 
le câble d’alimentation du modem, le câble reliant le modem à l’ordinateur et le câble 
raccordant le modem à la prise murale. Vérifiez les câbles et l’alimentation des routeurs 
et des concentrateurs Ethernet. 
Allumez et éteignez le modem puis réinitialisez-le
Éteignez le modem câble ou DSL, puis rallumez-le après quelques minutes. Certains FAI 
conseillent de débrancher le câble d’alimentation du modem. Si votre modem dispose 
d’un bouton de réinitialisation, vous pouvez l’actionner avant ou après avoir éteint puis 
rallumé le modem.
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Connexions PPPoE 
Si vous ne parvenez pas à vous connecter à votre fournisseur d’accès Internet via 
PPPoE, vérifiez d’abord les câbles et l’alimentation, éteignez et rallumez le modem, 
puis réinitialisez-le. 
Vérifiez les réglages des Préférences Système :
1 Choisissez Pomme () > Préférences Système.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez “Configurations de ports réseau”. 
4 Sélectionnez Ethernet intégré, puis faites glisser cette configuration en haut de la liste 
des configurations de ports. 
5 Dans le menu local Afficher, sélectionnez Ethernet intégré. 
6 Cliquez sur PPPoE. 
7 Sélectionnez “Se connecter via PPPoE”.
8 Vérifiez le champ Nom de compte pour vous assurer d’avoir tapé les informations 
correctes fournies par votre FAI. 
9 Si vous avez choisi d’enregistrer votre mot de passe, tapez-le à nouveau afin d’être sûr 
qu’il est correct. 
10 Cliquez sur TCP/IP. Assurez-vous d’avoir saisi dans cette sous-fenêtre les informations 
correctes fournies par votre FAI. 
11 Cliquez sur Appliquer.
Connexions au réseau
Si vous disposez de plusieurs ordinateurs tentant de partager une connexion à Internet, 
assurez-vous que votre réseau est correctement configuré. Vous devez savoir si votre 
FAI fournit une seule ou plusieurs adresses IP, autrement dit, une pour chaque 
ordinateur.
Si une seule adresse IP est utilisée, vous devez disposer d’un routeur capable de 
partager la connexion (on parle alors de conversion d’adresse réseau (NAT) ou de 
“masquage d’adresse IP”). Pour obtenir des informations sur la configuration, consultez 
la documentation fournie avec votre routeur ou contactez la personne qui a configuré 
votre réseau. La borne d’accès AirPort Extreme peut être utilisée pour que plusieurs 
ordinateurs partagent une adresse IP. Pour plus d’informations sur l’utilisation de la 
borne d’accès AirPort Extreme, consultez l’aide à l’écran ou rendez-vous sur le site Web 
AirPort, à l’adresse www.apple.com/fr/airport.
Si ces instructions s’avèrent insuffisantes pour résoudre les problèmes rencontrés, 
contactez votre FAI.
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Communications Regulation Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two 
conditions: (1) This device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. See instructions if 
interference to radio or television reception is 
suspected.
Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed 
and used properly—that is, in strict accordance with 
Apple’s instructions—it may cause interference with 
radio and television reception. 
This equipment has been tested and found to 
comply with the limits for a Class B digital device in 
accordance with the specifications in Part 15 of FCC 
rules. These specifications are designed to provide 
reasonable protection against such interference in a 
residential installation. However, there is no 
guarantee that interference will not occur in a 
particular installation. 
You can determine whether your computer system is 
causing interference by turning it off. If the 
interference stops, it was probably caused by the 
computer or one of the peripheral devices. 
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops. 
Â Move the computer to one side or the other of the 
television or radio. 
Â Move the computer farther away from the 
television or radio. 
Â Plug the computer into an outlet that is on a 
different circuit from the television or radio. (That 
is, make certain the computer and the television or 
radio are on circuits controlled by different circuit 
breakers or fuses.) 
If necessary, consult an Apple-authorized service 
provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician 
for additional suggestions. 
Changes or modifications to this product not 
authorized by Apple Computer, Inc., could void the 
EMC compliance and negate your authority to 
operate the product.
This product has demonstrated EMC compliance 
under conditions that included the use of compliant 
peripheral devices and shielded cables between 
system components. It is important that you use 
compliant peripheral devices and shielded cables 
(including Ethernet network cables) between system 
components to reduce the possibility of causing 
interference to radios, television sets, and other 
electronic devices. 
Responsible party (contact for FCC matters 
only): Apple Computer, Inc. Product Compliance, 1 
Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 
408-974-2000.
Bluetooth Information 
FCC Bluetooth Wireless Compliance
The antenna used with this transmitter must not be 
colocated or operated in conjunction with any other 
antenna or transmitter subject to the conditions of 
the FCC Grant.
Bluetooth Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.
Cet appareil numérique de la Class B respecte toutes 
les exigences du Règlement sur le matériel brouilleur 
du Canada.
Bluetooth Europe–EU Declaration of Conformity
This wireless device complies with the specifications 
EN 300 328, EN 301-489, and EN 60950 following the 
provisions of the R&TTE Directive.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B 
specifications. Cet appareil numérique de la classe B 
est conforme à la norme NMB-003 du Canada. 
VCCI Class B Statement
Communauté Européenne
Ce produit est conforme aux directives européennes 
72/23/CEE, 89/336/CEE et 99/5/CE.
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Laser Information
Do not attempt to disassemble the cabinet 
containing the laser. The laser beam used in this 
product is harmful to the eyes. The use of optical 
instruments, such as magnifying lenses, with this 
product increases the potential hazard to your eyes. 
For your safety, have this equipment serviced only 
by an Apple Authorized Service Provider. 
Because of the optical disc drive in your computer, 
your computer is a Class 1 laser product. The Class 1 
label, located in a user-accessible area, indicates that 
the drive meets minimum safety requirements. A 
service warning label is located in a serviceaccessible area. The labels on your product may 
differ slightly from the ones shown here. 
Exposure to Radio Frequency Energy
The radiated output power of the AirPort Extreme 
Card in this device is far below the FCC radio 
frequency exposure limits for uncontrolled 
equipment. This device should be operated with a 
minimum distance of at least 20 cm between the 
AirPort Extreme Card antennas (see page 28) and a 
person's body and must not be co-located or 
operated with any other antenna or transmitter.
Souris à diode électroluminescente (DEL) 
de Catégorie 1
La souris optique Apple est un produit à DEL de 
Catégorie 1 répondant aux normes IEC 60825-1 A1 
A2. Ce produit est conforme aux exigences des 
directives européennes 72/23/CEE et 89/336/CEE.
It also complies with the Canadian ICES-003 Class B 
Specification.
Taiwan Statement
Korea Statement
Avertissement relatif aux activités 
à haut risque
Cet ordinateur n’est pas conçu pour être utilisé dans 
des installations nucléaires, pour la navigation ou la 
communication aérienne, pour le contrôle du trafic 
aérien, ni dans aucune autre situation où une panne 
du système informatique pourrait entraîner la mort, 
des blessures ou de graves dommages écologiques.
ENERGY STAR® Compliance
As an ENERGY STAR® partner, Apple has determined 
that standard configurations of this product meet 
the ENERGY STAR guidelines for energy efficiency. 
The ENERGY STAR program is a partnership with 
office product equipment manufacturers to promote 
energy-efficiency. Reducing energy consumption of 
office products saves money and reduces pollution 
by eliminating wasted energy.
Disposal and Recycling Information
The backlight lamp in this product contains mercury. 
Dispose according to local, state, and federal laws. 
For information about Apple’s recycling program, go 
to www.apple.com/environment/summary.html
Élimination de la pile
Les piles usagées doivent être recyclées ou traitées 
conformément aux normes d’environnement locales.
Nederlands:Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) 
worden gedeponeerd.
Deutschland: Das Gerät enthält Batterien. Diese 
gehören nicht in den Hausmüll. Sie können 
verbrauchte Batterien beim Handel oder bei den 
Kommunen unentgeltlich abgeben. Um 
Kurzschlüsse zu vermeiden, kleben Sie die Pole der 
Batterien vorsorglich mit einem Klebestreifen ab.
Taiwan:
Warning: Making adjustments or performing 
procedures other than those specified in your 
equipment’s manual may result in hazardous 
radiation exposure.
Class 1 label Service warning label
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Informations relatives au téléphone 
et au modem Apple 56K
Informez votre opérateur téléphonique
Certains opérateurs téléphoniques exigent que vous 
informiez votre agence locale lorsque vous raccordez 
un modem à leur réseau. 
Information You Need in the United States 
The internal modem complies with Part 68 of the 
FCC rules. On the back of this equipment is a label 
that contains, among other information, the FCC 
registration number and ringer equivalence number 
(REN). If requested, provide this information to your 
telephone company. 
Â Ringer equivalence number (REN): 0.1B The REN is 
useful to determine the quantity of devices you 
may connect to your telephone lines and still have 
all those devices ring when your telephone 
number is called. In most, but not all areas, the 
sum of the RENs of all devices connected to one 
line should not exceed five (5.0). To be certain of 
the number of devices you may connect to your 
line, as determined by the REN, you should contact 
your local telephone company to determine the 
maximum REN for your calling area. 
Â Telephone jack type: USOC, RJ-11 An FCC-compliant 
telephone cord and modular plug are provided 
with this equipment. This equipment is designed 
to be connected to the telephone network or 
premises wiring using a compatible modular jack 
that complies with Part 68 rules. See the 
installation instructions for details.
Telephone Line Problems
If your telephone doesn’t work, there may be a 
problem with your telephone line. Disconnect the 
modem to see if the problem goes away. If it doesn’t, 
report the problem either to your local telephone 
company or to your company’s telecommunications 
people. 
If disconnecting the modem eliminates the problem, 
the modem itself may need service. See the service 
and support information that came with your Apple 
product for instructions on how to contact Apple or 
an Apple-authorized service provider for assistance. 
If you do not disconnect your modem when it is 
adversely affecting the telephone line, the telephone 
company has the right to disconnect your service 
temporarily until you correct the problem. The 
telephone company will notify you as soon as 
possible. Also, you will be informed of your right to 
file a complaint with the FCC. 
The telephone company may make changes in its 
facilities, equipment, operations, or procedures that 
could affect the operation of your equipment. If this 
happens, the telephone company will provide 
advance notice in order for you to make the 
necessary modifications to maintain uninterrupted 
service. 
The internal modem will not work with party lines, 
cannot be connected to a coin-operated telephone, 
and may not work with a private branch exchange 
(PBX). 
Telephone Consumer Protection Act 
The Telephone Consumer Protection Act of 1991 
makes it unlawful for any person to use a computer 
or other electronic device to send any message via a 
telephone fax machine unless such message clearly 
contains, in a margin at the top or bottom of each 
transmitted page or on the first page of the 
transmission, the date and time it was sent and an 
identification of the business or other entity, or 
individual sending the message and the telephone 
number of the sending machine of such business, 
entity, or individual.
Information You Need in Canada 
The Industry Canada (IC) label identifies certified 
equipment. This certification means that the 
equipment meets certain telecommunications 
network protective, operational, and safety 
requirements. The Department does not guarantee 
the equipment will operate to a user’s satisfaction. 
Before installing this equipment, make sure that you 
are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an 
acceptable method of connection to install the 
equipment. In some cases, you may extend the 
company’s internal wiring for single-line individual 
service by means of a certified telephone extension 
cord. Be aware, however, that compliance with these 
conditions may not prevent degradation of service 
in some situations. 
Repairs to certified equipment should be made by 
an authorized Canadian maintenance facility 
designated by the supplier. Any equipment 
malfunctions or repairs or alterations that you make 
to this equipment may cause the 
telecommunications company to request that you 
disconnect the equipment. 
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In Canada, contact Apple at: 7495 Birchmount Road, 
Markham, Ontario, L3R 5G2, 800-263-3394
Users should not attempt to make such connections 
themselves, but should contact the appropriate 
electric inspection authority or electrician.
Â Load number: 0.1 The load number (LN) assigned 
to each terminal device denotes the percentage of 
the total load to be connected to the telephone 
loop that is used by the device, to prevent 
overloading. The termination of a loop may consist 
of any combination of devices, subject only to the 
requirement that the sum of the load numbers of 
all devices does not exceed 100.
Â Telephone jack type: CA-11
Informations Destinées aux Utilisateurs Canadiens
L’étiquette d’Industrie Canada identifie un matériel 
homologué. Cette étiquette certifie que le matériel 
est conforme à certaines normes de protection, 
d’exploitation et de sécurité des réseaux de 
télécommunications. Le Ministère n’assure toutefois 
pas que le matériel fonctionnera à la satisfaction de 
l’utilisateur.
Avant d’installer ce matériel, l’utilisateur doit 
s’assurer qu’il est permis de la raccorder au réseau de 
l’enterprise locale de télécommunication. Le matériel 
doit également être installé en suivant une méthode 
acceptée de raccordement. Dans certains cas, le 
câblage appartenant à l’enterprise utilisé pour un 
service individuel à ligne unique peut être prolongé 
au moyen d’un dispositif homologué de 
raccordement (cordon prolongateur téléphonique).
L’abonné ne doit pas oublier qu’il est possible que la 
conformité aux conditions énoncées ci-dessus 
n’empêche pas la dégradation du service dans 
certaines situations. De fait, les enterprises de 
télécommunication ne permettent pas que l’on 
raccorde un matériel aux prises d’abonnés, sauf dans 
les cas précis prévus par les terifs particuliers de ces 
enterprises.
Les réparations de matériel homologué doivent être 
effectuées par un centre d’entretien canadien 
autorisé désigné par la fournisseur. La compagnie de 
télécommunications peut demander à l’utilisateur de 
débrancher un appareil suite à des réparations ou à 
des modifications effectuées par l’utilisateur ou en 
raison d’un mauvais fonctionnement.
Veuillez contacter Apple pour des informations 
supplémentaires:
Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
Service à la clientèle d’Apple Canada: 800-263-3394
L’utilisateur ne doit pas tenter de faire ces 
raccordements lui-même; il doit avoir recours à une 
service d’inspection des installations électriques ou à 
un électricien, selon le cas.
Â Numéro de charge: 0.1 L’indice de charge (IC) 
assigné à chaque dispositif terminal indique, pour 
éviter toute surcharge, le pourcentage de la 
charge totale qui sera raccordée à un circuit 
téléphonique bouclé utilisé par ce dispositif. La 
terminaison du circuit bouclé peut être constituée 
de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de 
l’ensemble des dispositifs ne dépasse pas 100.
Â Type de prise téléphonique: CA-11
Information You Need in the United Kingdom
This terminal equipment is intended for direct 
connection to the analogue Public Switched 
Telecommunications Network and is approved for 
use within the United Kingdom with the following 
features:
Â Modem facility
Â Autocalling facility
Â Autoanswer facility
Â DTMF signaling
Operation in the absence of proceed indication or 
upon detection of proceed indication
This product is in conformity with relevant 
regulatory standards following the provisions of 
European Council Directives 73/23/EEC (Low Voltage 
Directive) and 89/336/EEC amended by 92/31/EEC 
(EMC Directive).
Informationen fur Deutschland
Diese Modem-Karte ist als Endeinrichtung 
vorgesehen und muss an ein TAE mit F-Kodierung 
angeschlossen werden. Diese Endeinrichtung ist in 
Konformität gemäss Niederspannungsrichtlinie 73 / 
23 / EWG sowie EMC-Richtlinien 89 / 336 / EWG und 
92 / 31 / EWG.
Warning: Users should ensure for their own 
protection that the electrical ground connections 
of the power utility, telephone lines, and internal 
metallic water pipe system, if present, are 
connected together. This precaution may be 
particularly important in rural areas. 
Avertissement : Pour sa propre protection, 
l’utilisateur doit s’assurer que tout les fils de mise à 
la terre du secteur, des lignes téléphoniques et les 
canalisations d’eau métalliques, s’il y en a, soient 
raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions 
rurales.
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Informations pour la France
Ce matériel est conforme aux normes applicables de 
sécurité éléctrique d’après la directive 73 / 23 / CEE 
et aux normes applicables de comptabilité 
éléctromagnétique d’après la directive 89 / 336 / 
CEE, modifié par la directive 92 / 31 / CEE.
Information You Need in Australia
All telecommunications devices are required to be 
labelled as complying to the Australian 
telecommunications standards, ensuring the health 
and safety of the operator and the integrity of the 
Australian telecommunications network. To provide 
compliance with the Australian Communications 
Authority’s technical standards, please ensure that 
the following AT commands are maintained:
Â ATB0 (ITU/CCITT operation)
Â AT&G0 (no guard tone)
Â AT&P1 (33/66 pulse dial make/break ratio)
Â ATS0 = 0 or ATS0 = 1 (no answer or answer greater 
than one ring)
Â ATS6 = 95 (DTMF period between 70–255 ms)
Â ATS11 = 95 (DTMF period between 70–255 ms)
For calls that are automatically generated, a total of 
three call attempts are allowed to a telephone 
number, with a minimum period between calls of 2 
seconds. If the call does not connect after three 
attempts, 30 minutes must expire before automatic 
redialing may be initiated. Failure to set the modem 
(and any associated communications software) to 
the above settings may result in the modem being 
non-compliant with Australian telecommunications 
standards. Under these circumstances a user could 
be subject to significant penalties under the 
Telecommunications Act 1997.
This modem must be properly secured in order for 
you to use it. Telecommunications network voltages 
exist inside the computer and the 
telecommunications line connection must be 
removed before opening the computer.
Information You Need in New Zealand
This modem is fully approved to operate on the New 
Zealand telecommunications network under 
Telepermit number PTC 211/04/002. All 
telecommunications devices are required to hold a 
Telepermit and be labelled accordingly with the 
approved Telepermit number to comply with the 
New Zealand telecommunications standards, 
ensuring the health and safety of the operator and 
the integrity of the New Zealand 
telecommunications network. To ensure compliance, 
all calls that are automatically generated should not 
make more than 10 call attempts to the same 
number within any 30 minute period with a 
minimum period between calls of 30 seconds. 
Failure to adhere to these standards may result in 
the modem being non-compliant with New Zealand 
Telecom standards. Under these circumstances a 
user could be subject to significant penalties.
Important: The grant of a Telepermit for any item of 
terminal equipment indicates that only Telecom has 
accepted that the item complies with minimum 
conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, nor 
does it provide any sort of warranty. Above all, it 
provides no assurance that any item will work 
correctly in all respects with another item of 
Telepermitted equipment of a different make or 
model, nor does it imply that any product is 
compatible with all of Telecom’s network services.
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Let’s get started
When you start your MacBook Air for the first time, Setup Assistant will help 
you get going. Just follow a few simple steps to quickly connect to your Wi-Fi 
network, transfer your stuff from another Mac or a PC, and create a user 
account for your Mac.
You’ll also be able to log in with your Apple ID, so you can download apps 
from the App Store, shop the iTunes Store and the Apple Online Store, access 
iCloud, and make video calls with FaceTime. If you don’t have an Apple ID, 
creating one is easy and free. 
Multi-Touch gestures
You can do a lot of things on your MacBook Air using simple gestures on the 
trackpad. Here are some of the most popular ones.
Get to know your desktop
The desktop is where you can find everything and do anything on your Mac. 
The Dock at the bottom is a handy place to keep the apps you use most. 
It’s also where you can open System Preferences, which lets you customize 
your desktop and other settings on your Mac. Click the Finder icon to quickly 
get to all your files and folders.
The menu bar at the top has lots of useful information about your Mac. 
To check the status of your wireless Internet connection, click the Wi-Fi icon. 
Your Mac automatically connects to the network you chose during setup. 
Hello.
Multi-Touch 
trackpad
MagSafe 2 power 
connector
Power 
adapter
AC power 
cord
Power 
button
Click
Press down anywhere on the trackpad 
to click. Or, with Tap to Click enabled, 
simply tap the surface.
Secondary click (right click)
Click with two fingers to open shortcut 
menus. Or, with Tap to Click enabled, tap 
two fingers anywhere.
Swipe to navigate
Swipe with two fingers to flip through 
web pages, documents, and more. 
Double click
Press down two times anywhere on the 
trackpad. Or, with Tap to Click enabled, 
double-tap the surface.
Two-finger scroll
Brush two fingers along the trackpad 
to scroll in any direction—up, down, 
or sideways.
Smart zoom
Double-tap the trackpad with two 
fingers to quickly magnify a web page.
Pinch to zoom
Zoom in and out of photos and web 
pages more precisely by pinching your 
thumb and finger. 
Switch between full-screen apps
Swipe with three fingers to move 
from one full-screen app to another.
View Launchpad
Pinch with four fingers to view 
all your apps in Launchpad.
Rotate
Turn your thumb and finger clockwise 
or counterclockwise to rotate an image.
View Mission Control
Swipe up with three fingers to see 
every open window on your Mac.
Learn more
Choose System Preferences from the 
Apple menu and click Trackpad to learn 
more about gestures. 
iCloud
iCloud stores your music, photos, mail, and more. And it wirelessly pushes 
them to your Mac, iPad, iPhone, iPod touch, and even your PC. All without 
docking or syncing. So when you buy a song on one device, it’s automatically 
downloaded to all your others. And with Photo Stream, your latest photos 
appear everywhere you want to see them. To customize your iCloud settings, 
open the Apple menu, select System Preferences, and click iCloud. Then sign 
in with your Apple ID and choose the iCloud features you want to use.
An important note
Please read this document and the safety information in the Important 
Product Information Guide carefully before you first use your computer.
Learn more
You can find more information, watch demos, and learn even more about 
MacBook Air features at www.apple.com/macbookair.
Help
You can often find answers to your questions, as well as instructions 
and troubleshooting information, in Help Center. Click the Finder icon, 
click Help in the menu bar, and choose Help Center. 
Mac OS X Utilities
If you have a problem with your Mac, Mac OS X Utilities can help you 
repair your computer’s flash storage, restore your software and data from 
a Time Machine backup, or erase your flash storage and reinstall OS X Lion 
and Apple applications. You can also use Safari to get online help. If your 
Mac detects a problem, it opens Mac OS X Utilities automatically. Or you 
can open it manually by restarting your computer while holding down 
the Command and R keys. 
Support
Your MacBook Air comes with 90 days of technical support and one year 
of hardware repair warranty coverage at an Apple Retail Store or an Apple 
Authorized Service Provider. Visit www.apple.com/support/macbookair
for MacBook Air technical support. Or call 1-800-275-2273. In Canada, 
call 1-800-263-3394.
Not all features are available in all areas.
TM and © 2012 Apple Inc. All rights reserved. Designed by Apple in California. Printed in XXXX. 
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Quick Start Guide
Let’s get moving
It’s easy to move files like documents, email, photos, music, and movies 
to your new Mac from another Mac or a PC. The first time you start your 
new Mac, it will walk you through the process step by step. All you have 
to do is follow the onscreen instructions.
Welcome to your new MacBook Air. We’d like to show you around.
USB 3
FaceTime HD camera
SD USB 3
MagSafe 2
Thunderbolt
Wi-Fi 
status 
HeadphoneClick the icon in the Dock, and surf 
the web quickly and easily using 
Multi-Touch gestures. Scroll up 
or down with two fingers on the 
trackpad. Swipe right or left with 
two fingers to go back and forth 
Safari web browser Mail
Top Sites
Get a quick overview 
of the sites you visit 
most often.
One-stop email
View all your accounts in 
Mail for one-click access.
Conversation view
See all the email 
messages from a 
conversation thread.
Search
Quickly narrow search 
results to find exactly 
what you want.
Mail lets you manage all your 
email accounts from a single, 
ad-free inbox, even when you’re 
not connected to the Internet. It 
works with most email standards—
including POP3 and IMAP—and
between pages. Double-tap with 
two fingers to magnify a page, 
then double-tap again to return 
to the original size. Or pinch to 
zoom in or out. 
popular email services like Gmail, 
Yahoo! Mail, and AOL Mail. You can 
also use Mail with the free me.com 
email account you get with iCloud. 
The first time you open Mail, Setup 
Assistant will help you get started.
Launchpad
Open Launchpad
Click the Launchpad 
icon in the Dock.
Folders
Group apps in folders 
by dragging one app 
on top of another.
Launchpad is the home for all the 
apps on your Mac. Just click the 
Launchpad icon in the Dock and 
your open windows are replaced by 
a full-screen display of all your apps. 
Arrange apps any way you want, 
group them together in folders, 
or delete them from your Mac. 
When you download an app from 
the Mac App Store, it automatically 
appears in Launchpad.
Mission Control
Mission Control gives you a 
bird’s-eye view of everything 
running on your Mac. Click the 
Mission Control icon in the Dock, 
and your desktop zooms out 
to display all the open windows 
in every application, all your 
full-screen apps, and Dashboard, 
the home of mini-apps called 
widgets. Click anything to zoom 
in on it. Think of Mission Control 
as the hub of your system—view 
everything and go anywhere with 
just a click.
Open Mission Control
Click the Mission Control 
icon in the Dock.
Add desktop spaces
Click the + button 
to the right of the top 
row to add a new space.
Dashboard
Located at 
the top left for 
easy access.
Reading List
Click the glasses icon to 
save pages to read later.
Mac App Store
The Mac App Store is the best way 
to find and download thousands of 
apps for your Mac, from games and 
social networking to productivity 
apps and more. New apps install 
in one step to Launchpad. You 
can install apps on every Mac 
authorized for your personal use 
and even download them again. 
The Mac App Store lets you know 
when app updates are available, 
so you always have the latest 
versions. Open the Mac App Store 
by clicking its icon in the Dock.
iTunes
With iTunes, you can organize and 
play your digital music and videos 
on your Mac. And you can shop the 
iTunes Store for new music, movies, 
TV shows, books, and more. iTunes is 
also where you’ll find the App Store 
for iPad, iPhone, and iPod touch. 
iTunes Store
Discover and buy new music, 
movies, and more.
Genius Mixes
Let iTunes search your music 
library and group songs that 
go great together.
iCal
Multiple calendars
Access all your calendars 
from one place.
Keep track of your busy schedule 
with iCal. You can create separate 
calendars—one for home, another 
for school, a third for work. See 
all your calendars in a single 
window or choose to see only 
the calendars you want. Create 
and send invitations using contact 
info from your Address Book, then 
see who has responded. Use iCloud 
to update calendars on all your 
devices automatically or share 
calendars with other iCloud users. 
iPhoto
Create
Create books, 
cards, and calendars.
Faces
iPhoto can even organize 
your photos based on 
who’s in them.
Events
Double-click any Event 
to browse photos.
iPhoto is the best way to organize, 
browse, edit, and share your photos 
on your Mac. You can organize your 
photo library by Faces, Places, and 
Events. To send photos by email 
or publish them to Facebook, 
just select the photo and click Share 
in the bottom right of your screen. 
Or click Create to turn your favorite 
shots into photo books, calendars, 
and cards.
iMovie
Event browser
Your imported videos 
appear here so you 
can access all your clips.
Project browser
Simply drop your 
selection in a project 
to create a great movie.
iMovie puts all your video clips 
in one place, and gives you all the 
editing tools, themes, and special 
effects you need to quickly turn 
them into something special. You 
can make great-looking movies or 
even Hollywood-style movie trailers 
with just a few clicks. And iMovie lets 
you import video from most popular 
digital video cameras, your iPad, 
iPhone, or iPod touch, or the 
FaceTime camera on your Mac.
FaceTime
FaceTime for Mac lets you talk face 
to face with anyone on an iPad, 
iPhone, iPod touch, or Mac—from 
your Mac.* To set up FaceTime, 
all you need is your Apple ID and 
email address. To start a video call, 
just click an entry in your Address 
Book contacts list. 
Favorites
Add your frequent contacts 
to Favorites for easy access.
*Requires FaceTime-enabled device for both caller and recipient. Not available in all areas.
Calendar view
Select the view you 
prefer—day, week, 
month, or year.
Full-screen view
Click the full-screen button 
to go full screen.
Always up to date
Updates to your purchased apps 
appear automatically.
Add an event
Double-click to 
create a new event.
Discover new apps
Browse thousands of 
apps and download them 
straight to Launchpad.
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1 Installation
Félicitations pour l’acquisition de votre nouvel ordinateur 
Power Mac G5 à hautes performances. Ce chapitre 
contient des instructions pour l’installation de 
l’ordinateur et du moniteur.
Votre Power Mac G5 est doté de la dernière technologie informatique, notamment d’un 
processeur 64 bits évolué, de la mémoire rapide, d’une carte graphique AGP 8X Pro 
pour des effets visuels impressionnants et d’un stockage interne Serial ATA, le tout 
réuni dans un châssis en aluminium anodisé avec accès facile aux éléments internes. 
Positionnement de l’ordinateur et du moniteur
Soulevez l’ordinateur par ses deux poignées en utilisant des techniques de levage 
adaptées. Si votre moniteur est lourd, veillez à utiliser également des techniques 
de levage correctes lorsque vous le mettez en place. Placez le moniteur et l’écran 
de sorte que :
• ils reposent sur une surface plane et robuste ;
• les fiches des câbles d’alimentation ne soient coincées ni contre un mur ni contre 
tout autre objet ;
• rien n’obstrue la circulation d’air devant, derrière ou au-dessous du moniteur 
ou de l’ordinateur ;
• le plateau du lecteur optique dispose d’assez d’espace pour s’ouvrir.
Avertissement : Apple vous recommande d’utiliser votre Power Mac G5 en position 
verticale avec le panneau latéral placé correctement. L’ordinateur ne fonctionne pas 
correctement lorsqu’il est placé sur le côté ou lorsque le panneau latéral n’est pas en 
place.6 Chapitre 1 Installation
Le seul moyen de couper totalement l’alimentation de votre ordinateur et de votre 
moniteur consiste à débrancher leur fiche de la source d’alimentation électrique. 
Assurez-vous que les câbles d’alimentation de votre ordinateur et de votre moniteur 
soient facilement accessibles, pour pouvoir débrancher l’ordinateur ou le moniteur 
en cas de besoin.
Branchement de l’ordinateur
1 Enlevez tout film protecteur à l’intérieur du panneau latéral. Vous trouverez des 
instructions pour ouvrir le panneau latéral dans la section “Ouverture de l’ordinateur” à 
la page 44.
2 Enfoncez le câble d’alimentation fermement et complètement dans la prise encastrée 
au dos de l’ordinateur et branchez l’autre extrémité dans une prise de courant ou 
multiprise avec mise à la terre.
Fiche du câble d’alimentation
Prise du câble d’alimentationChapitre 1 Installation 7
3 Connectez les câbles du moniteur comme illustré ci-dessous : 
Important : en fonction de votre moniteur, vous devrez connecter un seul ou plusieurs 
câbles. Vérifiez les instructions fournies avec le moniteur pour d’autres informations sur 
sa configuration.
La carte d’affichage à l’intérieur de votre ordinateur est dotée des ports suivants :
• Un port de connecteur ADC (Apple Display Connector) pour connecter des 
moniteurs Apple à écran plat ; 
• Un port DVI (Digital Visual Interface) pour connecter des écrans numériques pourvus 
de connecteurs VI.
• Pour connecter un moniteur VGA, utilisez un adaptateur DVI vers VGA (fourni avec 
votre ordinateur) afin de pouvoir connecter le moniteur au port DVI.
• Pour connecter un deuxième moniteur ADC, utilisez un adaptateur DVI-ADC 
(non inclus) pour relier le moniteur au port DVI.
• Pour connecter une télévision, un magnétoscope ou un autre appareil vidéo, utilisez 
un adaptateur DVI vers Vidéo (non inclus) pour relier l’appareil au port DVI.
Pour plus d’informations sur la connexion d’un second moniteur, consultez les 
instructions du le chapitre 2, “Utilisation de votre ordinateur”.
Ports d’écran Ports USB Câble de l’écran
Port de moniteur DVI Port de moniteur ADC8 Chapitre 1 Installation
4 Pour accéder à Internet ou à un réseau, connectez votre ordinateur à un modem DSL 
ou câble, branchez votre modem à une ligne téléphonique analogique, ou connectezvous à un réseau Ethernet.
Port modem
Port EthernetChapitre 1 Installation 9
5 Connectez le câble du clavier à l’un des ports USB ( ) situés sur l’ordinateur ou sur le 
moniteur. Branchez le câble de la souris sur l’un des ports USB du clavier.
Remarque : si le câble du clavier n’est pas assez long pour atteindre un port USB de 
votre ordinateur, employez le câble d’extension clavier fourni avec votre ordinateur.
6 Allumez votre ordinateur en appuyant sur le bouton d’alimentation (®) en façade. 
Avec certains moniteurs Apple, vous pouvez également allumer l’ordinateur à l’aide 
du bouton d’alimentation du moniteur. Si votre moniteur doit être allumé séparément, 
faites-le en appuyant sur son bouton d’alimentation.
Clavier Souris
Branchez la souris sur 
l'un des ports USB à 
l'arrière du clavier.
Si vous voyez des bouts de film plastique 
à l'intérieur du panneau latéral (utilisés
comme protection lors du transport), 
ouvrez le panneau latéral et enlevez-les.
Câble d’extension clavier Apple Keyboard10 Chapitre 1 Installation
Utilisation d’un clavier d’une souris sans fil
Si vous avez fait l’acquisition d’un clavier Apple Wireless Keyboard et d’une souris Apple 
Wireless Mouse avec votre Power Mac G5, consultez les instructions fournies avec ces 
périphériques pour les configurer avec votre ordinateur.
En cas de problème
Si rien n’apparaît à l’écran après quelques instants ou si vous pensez que votre 
ordinateur n’a pas démarré correctement, effectuez les vérifications suivantes afin 
de tenter d’identifier la cause du problème :
• L’ordinateur est-il connecté à une source d’alimentation ? S’il est connecté à une 
multiprise munie d’un interrupteur, est-elle allumée ?
• Le câble d’alimentation est-il branché sur la prise située à l’arrière de l’ordinateur 
et correctement enclenché ? 
• Les câbles du clavier et du moniteur sont-ils correctement connectés ? 
• Le moniteur est-il allumé ? Les contrôles de luminosité et de contraste du moniteur 
sont-ils correctement réglés ? Si votre moniteur est muni de tels contrôles, réglez-les.
• Redémarrez votre ordinateur. Appuyez sur le bouton de mise en marche de 
l’ordinateur et maintenez-le enfoncé pendant environ 5 secondes jusqu’à ce que 
l’ordinateur s’éteigne. Appuyez à nouveau sur ce bouton pour allumer l’ordinateur.
• Si un point d’interrogation clignote à l’écran ou que le voyant d’état émet une série 
de clignotements lorsque vous allumez l’ordinateur, consultez le le chapitre 4, 
“Dépannage”, à la page 73.
Réglage de votre moniteur
Pour ajuster les réglages de votre moniteur, sélectionnez le menu Pomme (K) > 
Préférences Système et cliquez sur Moniteurs.
Pour plus de détails sur le dépannage de votre moniteur, consultez la section “Problèmes 
de moniteur” à la page 76. Pour plus de détails sur l’entretien de votre moniteur, consultez 
la section “Entretien de votre moniteur” à la page 90. L’Aide Mac OS contient des 
informations supplémentaires sur l’utilisation de votre moniteur. Chapitre 1 Installation 11
Et ensuite ?
Vous avez à présent accompli toutes les tâches nécessaires pour rendre votre 
Power Mac G5 opérationnel. la première fois que vous démarrez votre ordinateur, 
l’Assistant réglages se met en route. L’Assistant réglages vous aide à saisir les informations 
relatives à Internet et à votre courrier électronique ainsi qu’à configurer votre compte sur 
votre ordinateur. Si vous possédez déjà un autre ordinateur Mac, l’Assistant réglages peut 
également vous aider à transférer des fichiers, des applications et d’autres informations 
de votre ancien Mac vers votre nouveauPower Mac G5.
Transfert d’informations vers votre Power Mac G5
Vous pouvez utiliser l’Assistant réglages pour transférer automatiquement des 
informations d’un autre Mac vers votre nouveau Power Mac G5. Pour transférer des 
informations, assurez-vous des points suivants :
• Vous devez disposer d’un câble FireWire 6 broches vers 6 broches.
• L’autre ordinateur Mac dont vous disposez doit Mac OS X 10.1 ou ultérieur installé.
• Votre autre ordinateur Mac doit disposer d’un port FireWire intégré et prendre en 
charge le mode disque FireWire.
L’Assistant réglages vous guide tout au long du processus de transfert d’informations ; 
il vous suffit de suivre les instructions à l’écran. Le transfert d’informations vers votre 
Power Mac G5 n’affecte pas les informations se trouvant sur votre autre Mac. Vous 
pouvez transférer :
• les comptes d’utilisateur, y compris les préférences et le courrier électronique ;
• les réglages de réseau, pour que votre nouvel ordinateur soit automatiquement 
configuré avec les mêmes réglages de réseau que votre autre Mac ;
• les applications*, pour que toutes les applications que vous utilisiez sur votre autre 
ordinateur Mac soient désormais sur votre nouveau Power Mac G5 ;
• les fichiers et dossiers qui se trouvent sur votre disque dur et sur vos partitions. Cela 
vous permet d’accéder facilement aux fichiers et dossiers que vous utilisiez sur votre 
ancien Mac.
*Il est possible que vous ayez à réinstaller des applications que vous transférez.
Si vous n’utilisez pas l’Assistant réglages pour transférer des informations lorsque vous 
démarrez l’ordinateur pour la première fois, vous pouvez le faire plus tard. Allez dans 
le dossier Applications, ouvrez Utilitaires et double-cliquez sur “Assistant réglages”.12 Chapitre 1 Installation
Configuration de votre Power Mac G5 pour Internet
Si vous n’avez pas transféré les informations concernant le compte d’utilisateur et les 
réglages de réseau, l’Assistant réglages vous guide tout au long de la configuration de 
votre ordinateur et vous assiste en vue de la connexion à Internet. Pour les particuliers, 
l’accès à Internet requiert généralement l’ouverture d’un compte auprès d’un fournisseur 
d’accès à Internet (FAI) (payant dans certains cas).
• Si vous ne disposez d’aucun compte Internet, l’assistant vous facilitera son obtention.
• Si vous disposez déjà d’un compte Internet, consultez l’annexe C, “Connexion à 
Internet”, à la page 93 pour savoir quelles sont les informations à saisir.
Procédure à suivre lorsque vous avez fini de travailler
Lorsque vous avez terminé de travailler avec votre Power Mac G5, suspendez l’activité 
de votre ordinateur ou éteignez-le.
Suspension de l’activité de votre Power Mac G5
Cette option convient si vous n’utilisez pas votre Power Mac G5 pendant une période 
limitée. Lorsque l’ordinateur est en mode de suspension d’activité, son écran est noir. 
Vous pouvez le réactiver rapidement sans passer par la procédure de démarrage.
Pour suspendre rapidement l’activité de votre ordinateur, sélectionnez l’une 
des méthodes suivantes :
• Choisissez menu Pomme (K) > Suspendre l’activité. 
• Appuyez sur le bouton d’alimentation.
Pour remettre votre ordinateur en activité :
m
Appuyez sur n’importe quelle touche du clavier. 
Pour en savoir plus sur la suspension d’activité, consultez la section “Suspension de 
l’activité de l’ordinateur pour économiser l’énergie” à la page 41. Chapitre 1 Installation 13
Éteindre votre Power Mac G5
Cette option est préférable si vous ne comptez pas utiliser votre Power Mac G5 
pendant un jour ou deux. 
Pour éteindre votre ordinateur :
m
Choisissez menu Pomme (K) > Éteindre.
Avertissement : n’éteignez jamais votre ordinateur via l’interrupteur d’une multiprise 
ou en débranchant sa fiche d’alimentation, sauf si vous ne parvenez pas à l’éteindre 
d’une autre manière. Toute extinction incorrecte de l’ordinateur risque d’endommager 
vos fichiers ou logiciels système.
Avertissement : éteignez votre Power Mac G5 avant de le déplacer. Tout déplacement 
de votre ordinateur lorsque le disque dur est en train de tourner risque d’endommager 
ce dernier et d’entraîner une perte de données ou l’impossibilité de démarrer à partir 
du disque dur.14 Chapitre 1 Installation
Familiarisation avec votre ordinateur
Lecteur optique
Prise pour casque 
d'écoute
f
®Bouton d'alimentation
Témoin d'alimentation
Port USB 2.0
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Lecteur optique
Votre ordinateur possède une unité combinée ou Combo (DVD-ROM/CD-RW), ou un SuperDrive 
(DVD-R/CD-RW). Ces deux unités peuvent lire les disques DVD, les films DVD, les CD-ROM, les CD 
photos, les CD de musique, les disques audio standard et d’autres types de supports. Ils peuvent tous 
deux graver de la musique, des documents et d’autres types de fichiers numériques sur des disques 
CD-R et CD-RW vierges. Le graveur SuperDrive peut également enregistrer sur des disques DVD-R 
vierges. Pour ouvrir le lecteur optique, appuyez sur la touche d’éjection ( ) située sur votre clavier 
Apple.
Voyant d’état
Une lumière blanche indique que l’ordinateur est en activité, une lumière clignotante indique que 
l’ordinateur est en suspension d’activité.
® Bouton d’alimentation
Appuyez sur ce bouton pour allumer votre Power Mac G5, suspendre son activité ou la lui faire 
reprendre. Pour redémarrer votre ordinateur, maintenez ce bouton enfoncé pendant environ 5 
secondes jusqu’à ce que l’ordinateur s’éteigne, puis appuyez dessus une nouvelle fois pour allumer 
l’ordinateur.
Avec certains moniteurs Apple, vous pouvez également toucher ou enfoncer le bouton d’alimentation 
du moniteur pour allumer l’ordinateur ou suspendre son activité.
Port FireWire 400
Connectez votre Macintosh à des périphériques FireWire tels que l’iPod, des caméras vidéo 
numériques, des scanners et des disques durs. FireWire permet un transfert de données grande 
vitesse à tous ces périphériques. Le port FireWire 400 supporte des vitesses de transfert de 100, 200 
et 400 mégabits par seconde (Mbps).
f Prise pour casque d’écoute
Connectez des écouteurs à votre Macintosh via la prise pour écouteurs. Lorsqu’une prise est insérée 
dans la prise pour écouteurs, le haut-parleur interne est désactivé.
Port USB 2.0
Connectez votre Macintosh à des périphériques USB tels que claviers, souris, imprimantes, scanners, 
haut-parleurs, microphones et concentrateurs. Il est également possible que votre écran soit doté de 
ports USB.16 Chapitre 1 Installation
Ports et connecteurs : extension des capacités de votre ordinateur
Loquet Capots d’accès aux 
logements d’extension PCI
Port de moniteur DVI
Port d’antenne AirPort
Port d’antenne Bluetooth
Port de modem interne 
(sur certains modèles)
Port optique de sortie 
audio numérique 
Port optique d’entrée 
audio numérique
Prise d'alimentation
Port de moniteur ADC
Ports USB 2.0 (2)
Port FireWire 400
W
-
√
Port FireWire 800 GPort Ethernet
Port de sortie audio
Port d’entrée audioChapitre 1 Installation 17
s
Ç Loquet 
Soulevez le loquet pour ouvrir le panneau latéral et accéder aux éléments internes de votre 
Power Mac G5. Il est aussi possible de placer un verrou sur ce loquet pour empêcher l’accès 
aux éléments internes.
Port de moniteur DVI
Branchez un moniteur qui utilise un connecteur Digital Visual Interface (DVI). Vous pouvez également 
utiliser l’adaptateur DVI-VGA, fourni avec l’ordinateur, afin de connecter ce dernier aux moniteurs 
dotés d’un connecteur VGA.
Port d’antenne Airport Extreme
Branchez l’antenne AirPort Extreme sur ce port si une carte optionnelle AirPort Extreme est installée 
dans votre Macintosh.
Port d’antenne Bluetooth 
Si votre ordinateur est doté d’un module Bluetooth optionnel, branchez votre antenne Bluetooth®.
Ports USB 2.0
Connectez votre Macintosh à des périphériques USB tels que claviers, souris, imprimantes, scanners, 
haut-parleurs, microphones et concentrateurs USB. Votre clavier Apple et votre moniteur peuvent 
également être équipés de ports USB.
Ports FireWire 400 et 800
Le port FireWire 400 supporte des vitesses de transfert de 100, 200 et 400 Mbps. Le port FireWire 800 
supporte des vitesses de transfert de 100, 200, 400 et 800 Mbps.
Prise d’alimentation
Branchez-y le câble d’alimentation de l’ordinateur.
Capots d’accès aux logements d’extension PCI (3)
Étendez les capacités de votre Macintosh en installant jusqu’à 3 cartes PCI (Peripheral Component 
Interconnect) dans les logements couverts numérotés 2, 3 et 4. 
Port de moniteur ADC
Branchez un moniteur équipé d’un connecteur Apple Display Connector (ADC). 
Port optique de sortie audio numérique 
Reliez votre Macintosh à un récepteur ou à d’autres périphériques audio numériques.
Port optique d’entrée audio numérique
Reliez votre Macintosh à des périphériques audio numériques, tels que lecteurs CD et minidisque.
- Port analogique de sortie audio
Il permet de connecter des équipements MP3, CD et autres matériels audio à votre Macintosh. 
√ Port analogique d’entrée audio
Il permet de connecter des microphones et autres matériels audio à alimentation externe à votre 
Macintosh. 
G Port Ethernet paire torsadée 10/100/1000 
Connectez votre Macintosh à un réseau Ethernet grande vitesse pour accéder à Internet ou à des 
ressources du réseau tels que des imprimantes ou des serveurs et partager des informations à travers 
le réseau.
W Port de modem interne
Connectez à une ligne téléphonique ordinaire si votre Macintosh est doté d’un modem interne 
56K V.92 optionnel.18 Chapitre 1 Installation
Intérieur de votre Power Mac G5 : options d’extension interne 
de votre ordinateur
Baie de disque dur inférieure
Lecteur optique Baie de disque dur supérieure
Logement 1 : 
logement AGP 8X Pro 
(graphics card installed)
Logements SDRAM DDR 
(4 ou 8 logements,
selon le modèle)
Logements 2–4 : 
logements PCI ou PCI-X 
(selon le modèle)
Pile
Connecteur de
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Lecteur optique
Votre ordinateur possède soit un lecteur Combo (DVD-ROM/CD-RW) soit un lecteur-graveur 
SuperDrive (DVD-R/CD-RW). Pour plus d’informations sur le lecteur optique, voir “Utilisation de votre 
lecteur optique” à la page 34.
Pile
Votre ordinateur utilise une pile qu’il n’est nécessaire de remplacer que très rarement. Si votre 
ordinateur a des problèmes au démarrage ou que la date et l’heure du système sont souvent 
incorrectes, c’est qu’il est peut-être souhaitable que vous remplaciez la pile. Pour plus 
d’informations, consultez la section “Remplacement de la pile” à la page 70.
Connecteur de la carte AirPort Extreme
Connectez la carte AirPort Extreme, qui permet à votre ordinateur de communiquer avec un réseau 
sans fil. Pour en savoir plus, reportez-vous à la “Installation d’une carte AirPort Extreme” à la page 69.
Logements de mémoire SDRAM DDR
Augmentez la mémoire de votre ordinateur jusqu’à 4 ou 8 giga-octets (Go), selon votre modèle 
d’ordinateur. L’ajout se fait par insertion de paires de modules DIMM DDR SDRAM dans les logements 
mémoire. Pour plus d’informations, consultez la section “Installation de mémoire” à la page 49.
Baies de disque dur
Votre ordinateur est fourni avec un disque dur, installé dans la baie de disque dur supérieure. Vous 
pouvez installer un disque dur supplémentaire dans la baie de disque dur inférieure. Votre ordinateur 
accepte jusqu’à deux disques Serial ATA. Pour plus d’informations, consultez la section “Installation 
d’unités de stockage internes” à la page 56.
Logements PCI ou PCI-X
Selon le modèle, votre ordinateur dispose de logements d’extension PCI ou PCI-X, avec un total 
de trois logements. Vous pouvez installer des cartes PCI dans les logements 2 à 4 pour étendre 
les possibilités de votre ordinateur. Pour plus d’informations, consultez la section “Installation d’une 
carte d’extension PCI ou remplacement de la carte AGP” à la page 64.
Logement de carte AGP 8X Pro
Connectez votre moniteur à la carte insérée dans le logement AGP 8X Pro (advanced graphics port), 
qui fournit la puissance nécessaire au traitement rapide des graphiques. Vous pouvez aussi connecter 
un moniteur muni d’un connecteur de moniteur Apple (ADC) ou d’un connecteur d’interface visuelle 
numérique (DVI). 20 Chapitre 1 Installation
Informations supplémentaires
Pour obtenir davantage d’informations, consultez les sections suivantes : 
Pour en savoir plus sur... Consultez la section...
L’extinction ou la suspension 
d’activité de votre ordinateur
“Procédure à suivre lorsque vous avez fini de travailler” à la page 12.
Utilisation d’une caractéristique 
matérielle spécifique de votre 
Power Mac G5
le chapitre 2, “Utilisation de votre ordinateur”, à la page 21.
Installation de disques durs, 
de lecteurs, de mémoire et 
de cartes supplémentaires 
ou remplacement de la pile
le chapitre 3, “Interventions à l’intérieur de l’ordinateur”, à la 
page 43.
Que faire en cas de problème 
vous empêchant d’utiliser votre 
ordinateur
le chapitre 4, “Dépannage”, à la page 73.
Installation de la gestion 
de Classic pour utiliser 
les applications Mac OS 9 
avec votre ordinateur
le chapitre 4, “Dépannage”, à la page 73
Connexion de votre ordinateur 
à Internet
l’annexe C, “Connexion à Internet”, à la page 93.2
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2 Utilisation de votre ordinateur
Ce chapitre fournit des instructions concernant 
l’utilisation des fonctions importantes de votre 
ordinateur Power Mac G5, notamment le clavier, 
la souris, les ports FireWire, USB, audio, la technologie 
sans fil Bluetooth et la mise en réseau. 
Ce chapitre fournit des explications sur les sujets suivants :
• “Utilisation de votre clavier Apple” à la page 22
• “Utilisation de votre souris Apple Mouse” à la page 23
• “Branchement d’un second moniteur” à la page 23
• “Connexion d’un téléviseur, d’un magnétoscope ou de tout autre appareil vidéo” à la 
page 24
• “Utilisation de l’Universal Serial Bus (USB)” à la page 26
• “Utilisation de FireWire” à la page 28
• “Utilisation des périphériques audio” à la page 30
• “Utilisation de appareils Bluetooth” à la page 32
• “Utilisation de votre lecteur optique” à la page 34
• “Utilisation de votre modem” à la page 36
• “Connexion à un réseau Ethernet” à la page 37
• “Accès sans fil à Internet et à votre réseau local via AirPort” à la page 39
• “Suspension de l’activité de l’ordinateur pour économiser l’énergie” à la page 41
• “Transfert d’informations entre deux ordinateurs Macintosh” à la page 4222 Chapitre 2 Utilisation de votre ordinateur
Utilisation de votre clavier Apple
Votre clavier Apple Keyboard dispose de touches de fonction préréglées pour les 
tâches récurrentes. Appuyez sur la touche d’éjection de disque ( ) pour éjecter les 
disques du lecteur optique. Appuyez sur les touches de hausse et de baisse du volume 
pour régler le son ou sur la touche Silence pour l’activer ou le désactiver. Utilisez les 
touches d’augmentation et de réduction de la luminosité pour régler la luminosité 
d’un moniteur Apple.
Remarque : appuyez sur la touche F12 sur un clavier qui n’est pas de la marque 
Apple pour éjecter les disques du lecteur optique.
Le clavier Apple est doté de deux ports Universal Serial Bus (USB) 1.1. Vous pouvez 
brancher le câble de votre souris ou d’autres périphériques USB dans les ports USB 
à l’arrière du clavier. 
Remarque : si vous avez acheté un clavier Apple Wireless Keyboard avec votre 
Power Mac G5, consultez les instructions livrées avec votre clavier pour obtenir 
de plus amples informations.
Informations supplémentaires à propos de votre clavier
Des informations supplémentaires sur votre clavier sont disponibles dans l’Aide 
Mac OS. Choisissez Aide > Aide Mac, puis recherchez “clavier”. 
Touches de fonction
Touche de baisse du volume
-Touche d’augmentation du volume
Touche de baisse de la luminosité
Touche d’augmentation de la luminosité
— Touche Silence
Touche d’éjection de disque
Câble clavier
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Utilisation de votre souris Apple Mouse
Votre souris Apple Mouse utilise un système de repérage optique. Pour positionner le 
pointeur à l’aide de votre souris, déplacez celle-ci sur n’importe quelle surface adaptée, 
telle que le bureau, le tapis de souris ou toute autre surface granuleuse (certaines 
surfaces lisses et brillantes ne permettent pas un contrôle du pointeur aussi performant 
que d’autres). Pour cliquer sur un objet, appuyez une fois sur le corps de la souris 
jusqu’à ce que vous ressentiez un clic. Pour double-cliquer sur un élément, appuyez 
deux fois successivement et rapidement. 
Remarque : si vous avez acheté une souris Apple Wireless Mouse avec votre 
Power Mac G5, consultez les instructions livrées avec votre souris pour obtenir 
de plus amples informations.
Informations supplémentaires à propos de votre souris
Des informations supplémentaires sur votre souris sont disponibles dans l’Aide Mac OS. 
Choisissez Aide > Aide Mac, puis recherchez “souris”.
Branchement d’un second moniteur 
Vous pouvez connecter deux moniteurs à votre carte graphique et les utiliser 
simultanément. Si un deuxième moniteur est connecté, vous pouvez soit afficher la 
même image sur les deux moniteurs (mode miroir), soit utiliser le deuxième écran pour 
étendre la taille de votre bureau Mac OS X (mode bureau étendu). Il est nécessaire de 
disposer du câble approprié pour chaque moniteur à connecter. 
Pour utiliser plusieurs moniteurs :
1 Éteignez les moniteurs et votre ordinateur.
2 Branchez le câble vidéo de chaque moniteur au port approprié de la carte graphique.
3 Allumez les moniteurs et démarrez votre ordinateur.
Pour régler les moniteurs, sélectionnez menu Pomme (K) > Préférences Système et 
cliquez sur Moniteurs. 
Si vous êtes en bout de course faute de place
mais que vous voulez conserver le clic lorsque 
vous soulevez la souris, cliquez, puis 
appuyez sur les côtés avec le pouce 
et les doigts tandis que vous soulevez.24 Chapitre 2 Utilisation de votre ordinateur
Par défaut, votre ordinateur démarre en mode bureau étendu. Pour travailler en mode 
miroir, sélectionnez Pomme (K) > Préférences Système, cliquez sur Moniteurs et 
sélectionnez En miroir.
Pour en savoir plus sur les moniteurs
Pour obtenir des informations sur la connexion de votre moniteur, lisez les instructions 
d’installation dans le chapitre 1, “Installation”.
L’Aide Mac OS fournit des informations supplémentaires sur l’utilisation et la 
configuration d’un moniteur externe. Choisissez Aide > Aide Mac, puis recherchez 
“moniteur”. 
Connexion d’un téléviseur, d’un magnétoscope ou de 
tout autre appareil vidéo
Vous pouvez connecter votre Power Mac G5 à une télévision, un magnétoscope, un 
projecteur ou un autre périphérique vidéo externe grâce à l’adaptateur DVI vers Vidéo, 
conçu pour être employé avec un Power Mac G5. Vous trouverez un adaptateur DVI 
vers Vidéo chez votre revendeur agréé Apple, dans un centre de distribution Apple 
ou en ligne sur Apple Store à l’adresse www.apple.com/store. 
Pour connecter un périphérique vidéo :
1 Éteignez le périphérique vidéo et votre ordinateur.
2 Connectez l’extrémité DVI de l’adaptateur DVI vers Vidéo au port DVI de la carte 
graphique de votre Power Mac G5.
3 Connectez l’autre extrémité de l’adaptateur au port vidéo composite (RCA) ou S-vidéo 
du téléviseur, du magnétoscope ou du projecteur.
4 Allumez le périphérique vidéo et démarrez votre ordinateur.Chapitre 2 Utilisation de votre ordinateur 25
Pour ajuster l’image, sélectionnez menu Pomme (K) > Préférences Système, puis 
cliquez sur Moniteurs. 
Port d’affichage DVI 
Port de sortie S-vidéo
Adapteur DVI vers Vidéo
Port de sortie vidéo Composite26 Chapitre 2 Utilisation de votre ordinateur
Utilisation de l’Universal Serial Bus (USB)
Votre Power Mac G5 est équipé de trois ports USB 2.0 ; un en façade et deux à l’arrière. 
Votre clavier Apple Keyboard possède également deux ports USB 1.1. Ces ports USB 
permettent de connecter de nombreux types de périphériques, notamment des 
imprimantes, des scanners, des appareils photo numériques, des microphones, des 
manettes de jeu, des claviers, des souris et des unités de stockage. La technologie USB 
facilite la connexion de périphériques externes. Dans la plupart des cas, vous pouvez 
connecter et déconnecter un périphérique USB pendant que l’ordinateur fonctionne. 
Vous pouvez utiliser les périphériques dès leur branchement, sans avoir à redémarrer 
votre ordinateur. 
Utilisation de périphériques USB
Apple fournit d’origine des logiciels compatibles avec de nombreux périphériques 
USB. Dans la plupart des cas, il n’est pas nécessaire d’installer le pilote fourni avec 
le périphérique. Si vous connectez un périphérique USB et que votre Power Mac G5 
ne trouve pas le pilote approprié, vous pouvez soit installer le pilote fourni avec le 
périphérique, soit vous adresser au fabricant du périphérique pour trouver, télécharger 
et installer le pilote approprié.
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Connexion de plusieurs périphériques USB
Pour connecter plus de trois périphériques USB, vous pouvez vous procurer un 
concentrateur USB. Ce dernier se connecte à un port disponible de votre ordinateur 
et offre des ports USB supplémentaires (généralement quatre ou sept). 
Remarque : pour utiliser certains périphériques USB, il se peut que vous ayez besoin 
d’un concentrateur USB.
Informations supplémentaires sur la technologie USB
L’Aide Mac OS fournit des informations supplémentaires sur la technologie USB. 
Choisissez Aide > Aide Mac, puis recherchez “USB”. Vous trouverez d’autres informations 
sur le site Web USB d’Apple, à l’adresse www.apple.com/usb. 
Pour obtenir des informations concernant les périphériques USB disponibles pour votre 
ordinateur, consultez le Guide des produits Macintosh à l’adresse www.apple.com/guide. 
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Utilisation de FireWire 
FireWire est un système de transfert de données à haute vitesse qui vous permet de 
connecter et déconnecter aisément des périphériques tels que l’iPod, les caméras 
vidéonumériques (DV), les imprimantes, les scanners et les disques durs. Vous pouvez 
connecter et déconnecter des périphériques FireWire sans redémarrer votre ordinateur. 
Votre ordinateur est équipé de trois ports FireWire externes.
• Deux ports FireWire 400, un en façade et un à l’arrière, acceptent un taux de transfert 
de données maximal de 400 mégabits par seconde (Mbps).
• À l’arrière, un port rapide FireWire 800 accepte un taux de transfert de données 
maximal de 800 mégabits par seconde (Mbps).
Le port FireWire 800 de votre Power Mac G5 peut transférer des données depuis des 
périphériques FireWire 800 Mbps bien plus rapidement qu’auparavant. Ce port est 
équipé d’un connecteur à 9 broches et est compatible avec les premiers périphériques 
FireWire, qui ont des connecteurs de 4 ou 6 broches.
Avec un câble approprié, le port 9 broches est parfaitement compatible avec tous les 
périphériques FireWire. Des câbles sont disponibles pour connecter le port 9 broches 
à des périphériques 4, 6 ou 9 broches.
Ports FireWire 400 
Port FireWire 800 
FireWire 400 (6 broches) FireWire 400 (4 broches) FireWire 800 (9 broches)Chapitre 2 Utilisation de votre ordinateur 29
Utilisation de périphériques FireWire
La technologie FireWire vous permet de :
• Connecter une caméra vidéo numérique FireWire et capturer ou transférer directement 
de la vidéo de haute qualité vers ou à partir de votre ordinateur, puis d’utiliser ensuite 
un logiciel de montage vidéo tel que iMovie pour monter vos images vidéo. 
• Connecter un disque dur FireWire externe pour faire une copie de sauvegarde des 
données ou transférer des fichiers. Une unité de disque avec icône FireWire apparaît 
sur votre bureau une fois que vous connectez le disque dur à votre Power Mac G5. 
Certains disques durs FireWire sont alimentés via le câble FireWire, ce qui vous 
dispense de les brancher sur une source d’alimentation externe.
• Si une défaillance empêche votre ordinateur de démarrer ou de transférer des 
fichiers, il est possible de connecter votre Power Mac G5 à un autre ordinateur via 
FireWire afin que votre Power Mac G5 apparaisse comme un disque dur externe 
sur l’autre ordinateur (fonctionnalité appelée mode disque cible FireWire). Consultez 
ci-dessous la section “Mode disque cible FireWire” pour plus d’informations.
Pour utiliser un périphérique FireWire, connectez-le à l’ordinateur et installez les pilotes 
éventuellement fournis avec le périphérique. Votre ordinateur détecte automatiquement 
la connexion d’un nouveau périphérique. 
Pour démarrer à partir d’un disque dur FireWire sur lequel est installé Mac OS X, 
sélectionnez menu Pomme (K) > Préférences Système, cliquez sur Disque de 
démarrage et sélectionnez le disque dur FireWire. 
Si votre disque dur FireWire ne figure pas dans la liste ou que vous ne pouvez pas le 
sélectionner, contactez votre revendeur pour obtenir des pilotes mis à jour.
Pour déconnecter votre disque dur FireWire en toute sécurité, faites glisser son icône 
dans la Corbeille avant de déconnecter le câble FireWire.
Mode disque cible FireWire
Si vous souhaitez transférer des fichiers de votre Power Mac G5 vers un autre 
ordinateur équipé de la technologie FireWire, ou que vous êtes confronté à un 
problème qui empêche le démarrage de votre ordinateur, utilisez le mode disque 
cible FireWire pour connecter votre Power Mac G5 à un autre ordinateur.
Remarque : pour que votre Power Mac G5 puisse fonctionner en mode disque cible 
FireWire, l’ordinateur associé doit disposer de n’importe quelle version de Mac OS X ou 
de Mac OS 9 et de FireWire version 2.3.3 ou ultérieure. Utilisez Informations Système, 
dans les répertoires Applications/Utilitaires, pour vérifier la version de FireWire installée. 
Si l’autre ordinateur dispose d’une version antérieure, vérifiez s’il existe une mise à jour 
sur le site Web AppleCare Support à l’adresse www.apple.com/support. 30 Chapitre 2 Utilisation de votre ordinateur
Pour connecter votre Power Mac G5 en mode disque cible FireWire :
1 Éteignez votre Power Mac G5. 
2 Utilisez un câble FireWire muni de connecteurs appropriés à 6 ou 9 broches à chaque 
extrémité pour connecter votre ordinateur à un autre ordinateur équipé de FireWire.
3 Démarrez ou redémarrez votre Power Mac G5 et maintenez immédiatement la touche T 
enfoncée.
Le moniteur de votre Power Mac G5 affiche l’indicateur de mode du disque FireWire 
et l’icône du disque dur interne du Power Mac G5 apparaît sur le bureau de l’autre 
ordinateur.
4 Lorsque vous avez terminé le transfert de fichiers : sur l’autre ordinateur, glissez l’icône 
du disque dur Power Mac G5 jusqu’à la Corbeille pour démonter le disque.
5 Appuyez sur le bouton d’alimentation du Power Mac G5 pour éteindre ce dernier, 
puis déconnectez le câble FireWire.
Informations supplémentaires sur la technologie FireWire
Des informations supplémentaires relatives à FireWire sont disponibles sur le site Web 
FireWire d’Apple à l’adresse www.apple.com/firewire. Vous trouverez également des 
informations dans l’Aide Mac OS. Choisissez Aide > Aide Mac, puis recherchez “FireWire”. 
Pour obtenir des informations sur les périphériques FireWire disponibles pour votre 
ordinateur, consultez le Guide des produits Macintosh à l’adresse www.apple.com/guide. 
Utilisation des périphériques audio
Votre Power Mac G5 est doté de nombreux dispositifs audio, notamment une prise 
casque en façade, ainsi que des ports de sortie audio numérique, entrée audio 
numérique optique, sortie audio analogique et entrée audio analogique à l’arrière. 
Ports audio numérique optique
Un câble numérique optique ou Toslink permet de connecter un lecteur Digital Audio 
Tape (DAT) ou un lecteur CD au port d’entrée audio numérique optique, pour enregistrer 
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Vous pouvez également brancher un récepteur audio ou audiovisuel (AV) au port 
de sortie audio numérique optique pour construire un système home cinema à partir 
du Power Mac G5. 
Prise pour écouteurs
Sur l’ordinateur, la prise pour écouteurs est prévue pour brancher des écouteurs. 
Lorsqu’une prise y est insérée, votre haut-parleur intégré est désactivé.
Important : ne branchez pas de périphériques de sortie dans la prise pour écouteurs. 
Utilisez pour cela le port de sortie analogique à l’arrière.
Ports audio analogique
Au dos de l’ordinateur, les mini-jacks d’entrée et sortie analogique permettent de 
connecter un microphone externe ou d’autres équipements audio.
Pour sélectionner le périphérique audio d’entrée ou de sortie à employer, utilisez la 
fenêtre Son des Préférences Système.
Port optique 
d’entrée 
audio numérique
Port optique 
de sortie 
audio numérique Câble optique numérique
Câble optique numérique
Récepteur AV
Vers haut-parleurs 
ou autres sorties
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Utilisation de appareils Bluetooth
Votre Power Mac G5 peut se connecter et transférer des informations vers des 
périphériques exploitant la technologie sans fil Bluetooth®, comme le clavier et la souris 
sans fil d’Apple, des téléphones portables, des assistants numériques personnels (PDA) 
et des imprimantes, ce qui permet ainsi d’éliminer les câbles servant traditionnellement 
à relier les périphériques. Les périphériques Bluetooth peuvent communiquer entre eux 
dans un rayon de 10 mètres.
Si votre ordinateur est fourni avec un module Bluetooth intégré, assurez-vous de 
branchez l’antenne Bluetooth accompagnant votre ordinateur dans le port d’antenne 
Bluetooth ( ) à l’arrière de l’ordinateur. La petite antenne cylindrique Bluetooth permet 
la réception des périphériques Bluetooth.
Insérez l’antenne Bluetooth 
dans le port prévu à cet effet.Chapitre 2 Utilisation de votre ordinateur 33
Voici quelques activités réalisables avec la technologie sans fil Bluetooth :
• Utiliser un clavier Apple Wireless Keyboard ou une souris Apple Wireless Mouse avec 
votre Power Mac G5.
• Communiquer avec votre assistant personnel (PDA). Exécuter une opération HotSync 
sans fil ou transmettre votre carte de visite ou encore des événements de calendrier 
directement sur le PDA d’un collègue. 
• Utiliser votre Power Mac G5 pour communiquer avec un téléphone mobile compatible 
avec la technologie Bluetooth. Utiliser iSync pour mettre à jour votre téléphone avec 
les informations de contact du Carnet d’adresses de votre Macintosh.
Si votre Power Mac G5 n’est pas équipé d’un module Bluetooth, vous pouvez télécharger 
le logiciel Bluetooth et connecter un adaptateur USB Bluetooth externe d’une autre 
marque à l’un des ports USB disponibles sur votre ordinateur.
Pour plus d’informations sur la technologie sans fil Bluetooth
Si votre ordinateur a été livré avec un module Bluetooth intégré, vous pouvez obtenir 
de l’aide sur l’utilisation de la technologie Bluetooth en ouvrant l’application Échange 
de fichiers Bluetooth (dans le répertoire Applications/Utilitaires) et en sélectionnant 
Aide Bluetooth dans le menu Aide. Vous trouverez d’autres informations sur le site 
Web Bluetooth d’Apple, à l’adresse www.apple.com/bluetooth.
Important : les modules Bluetooth ne peuvent pas être installés par l’utilisateur. Si 
vous avez acheté un Power Mac G5 sans module Bluetooth, vous pouvez acheter un 
adaptateur externe Bluetooth USB chez votre revendeur agréé Apple, dans un centre 
de distribution Apple ou en ligne sur Apple Store à l’adresse www.apple.com/store.34 Chapitre 2 Utilisation de votre ordinateur
Utilisation de votre lecteur optique
Votre lecteur optique permet d’installer ou d’exécuter des applications à partir de CD 
ou DVD. Il permet également de lire des données multimédia à partir de CD, d’écouter 
de la musique à partir de CD audio, de graver de la musique, des documents et autres 
fichiers numériques sur des disques CD-R ou CD-RW. Vous pouvez également lire des 
films DVD et utiliser la plupart des disques DVD. Si votre ordinateur est équipé d’un 
graveur SuperDrive, vous pouvez enregistrer des informations sur disques DVD-R 
(DVD enregistrables) vierges. 
Remarque : si vous disposez de logiciels anciens stockés sur disquettes, contactez les 
éditeurs concernés pour savoir s’il existe des versions disponibles sur CD ou achetez un 
lecteur de disquettes USB externe adapté à votre Power Mac G5 chez votre distributeur 
agréé Apple, dans un centre de distribution Apple ou sur le site Apple Store à l’adresse 
www.apple.com/store.
Insertion d’un disque
Pour installer ou utiliser des programmes à partir de CD ou de DVD :
1 L’ordinateur étant allumé, ouvrez le lecteur en appuyant sur la touche d’éjection 
de disque ( ) de votre clavier Apple Pro Keyboard.
2 Placez un disque sur le plateau en veillant à le poser bien à plat, étiquette vers le haut.
3 Appuyez à nouveau sur la touche d’éjection de disque ( ) ou poussez doucement 
le plateau afin de le fermer. 
Dès que l’icône du disque s’affiche à l’écran, le disque est prêt à être utilisé.
Éjection d’un disque
Vous pouvez éjecter un disque soit en glissant son icône dans la Corbeille, soit en 
appuyant sur la touche d’éjection de disque ( ) de votre clavier Apple. Vous pouvez 
également éjecter un disque en maintenant le bouton de la souris enfoncé lors du 
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Enregistrement d’informations sur CD
Votre lecteur optique permet de graver vos morceaux de musique, programmes 
et fichiers favoris sur des disques CD-R et CD-RW. Créez vos propres CD de musique 
et écoutez-les sur n’importe quel lecteur audio standard. Vous pouvez également 
enregistrer des fichiers informatiques, tels que des applications, des documents 
ou autres fichiers numériques sur un CD enregistrable. 
Avec les disques enregistrables CD-R (CD enregistrable), vous ne pouvez enregistrer les 
informations qu’une seule fois. Bien que vous ne puissiez pas modifier les informations 
enregistrées, vous avez peut-être la possibilité d’ajouter des informations jusqu’à ce 
que le disque soit plein, selon l’application utilisée. Pour obtenir des informations 
spécifiques concernant l’enregistrement sur votre disque CD-R, reportez-vous à la 
documentation fournie avec votre application. Il est préférable d’utiliser des disques 
CD-R pour graver des CD audio, car il se peut que votre lecteur CD ne puisse pas lire 
les disques CD-RW (disques réenregistrables).
Avec les disques CD-RW, vous pouvez sauvegarder et modifier des informations sur 
un même CD à l’infini. Toutefois, certains logiciels conçus pour enregistrer des fichiers 
multimédia sur CD ne peuvent enregistrer qu’une seule fois des données sur un disque.
Pour enregistrer de la musique provenant de la bibliothèque iTunes sur un CD-R :
1 Ouvrez iTunes (cliquez sur son icône dans le Dock).
2 Sélectionnez la liste de lecture à enregistrer.
3 Insérez un disque CD-R vierge.
4 Cliquez sur le bouton Graver le CD, en haut de la fenêtre iTunes.
Pour enregistrer des données sur un CD-R à partir du Finder :
1 Insérez un disque CD-R vierge.
2 Dans la boîte de dialogue qui apparaît, attribuez un nom au disque et sélectionnez 
le format souhaité. Une icône correspondant au CD apparaît sur le bureau.
3 Double-cliquez sur l’icône du CD, puis glissez-y des fichiers et des dossiers.
4 Choisissez Fichier > Graver le disque ou sélectionnez le disque, puis glissez-le sur 
l’icône “Graver le disque” située dans le Dock.
Pour savoir comment faire afin d’enregistrer des fichiers musicaux sur un CD avec 
iTunes, consultez l’Aide iTunes. Ouvrez iTunes (dans Applications) et sélectionnez 
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Enregistrement d’informations sur un DVD
Si vous disposez d’un SuperDrive, vous pouvez enregistrer un DVD interactif avec vos 
propres films numériques sur un disque DVD-R (DVD enregistrable) vierge. Vous pouvez 
également enregistrer d’autres types de données numériques sur les disques DVD-R 
afin, par exemple, de sauvegarder des fichiers. Toutefois, une fois que vous avez 
enregistré des informations sur un disque DVD-R, elles ne peuvent plus être écrasées.
Avec les applications telles que iDVD ou DVD Studio Pro, vous pouvez créer votre 
propre projet DVD personnalisé, le graver sur un disque DVD-R et le lire sur la plupart 
des lecteurs DVD standards.
Pour graver un disque avec iDVD :
1 Ouvrez iDVD ainsi que votre projet DVD final.
2 Cliquez sur le bouton Graver le DVD.
3 Insérez un disque DVD-R vierge dans le graveur dès qu’un message vous y invite.
4 Cliquez de nouveau sur le bouton Graver le DVD.
Pour graver des données sur un DVD-R à partir du Finder :
1 Insérez un disque DVD-R vierge dans le graveur.
2 Dans la zone de dialogue qui apparaît, attribuez un nom au disque et sélectionnez 
le format souhaité. Une icône représentant le DVD apparaît sur le bureau.
3 Double-cliquez sur l’icône du DVD, puis glissez-y des fichiers et des dossiers.
4 Choisissez Fichier > Graver le disque ou sélectionnez le disque, puis glissez-le 
sur l’icône “Graver le disque” située dans le Dock.
Pour plus d’informations sur iDVD, ouvrez iDVD (dans Applications) et sélectionnez 
l’Aide iDVD dans le menu Aide.
Utilisation de votre modem
Votre Macintosh peut être fourni avec un modem interne 56 K Apple. Pour connecter le 
modem interne 56K Apple, branchez l’une des extrémités du câble modem ou du câble 
RJ-11 sur le port du modem qui se trouve à l’arrière de l’ordinateur et l’autre extrémité 
sur une prise téléphonique RJ-11 standard.
Port modem
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Important : veillez à connecter le modem interne à une ligne téléphonique analogique 
(type le plus répandu chez les particuliers). S’il est branché sur une ligne téléphonique 
numérique, le modem ne fonctionnera pas et risquera même d’être endommagé.
Pour obtenir des informations sur la manière d’établir une connexion à Internet, consultez 
l’annexe C, “Connexion à Internet”, à la page 93. Des informations supplémentaires à 
propos du modem interne sont également disponibles dans l’Aide Mac OS.
Connexion à un réseau Ethernet
Votre ordinateur comprend des fonctionnalités intégrées de mise en réseau Ethernet 
par câbles à paires torsadées à un débit de 10/100/1000 mégabits par seconde (Mbps). 
Vous pouvez les utiliser pour vous connecter à un réseau, à un modem câble ou à un 
modem DSL. 
La connexion à un réseau vous donne accès à d’autres ordinateurs Elle vous permet 
de stocker et de récupérer des informations, d’utiliser les imprimantes d’un réseau et 
une messagerie électronique ou de vous connecter à Internet. Vous pouvez également 
utiliser Ethernet pour partager des fichiers entre deux ordinateurs ou établir un petit 
réseau.
Si vous vous connectez à un réseau existant, vous pouvez obtenir des renseignements 
sur le réseau lui-même et sur les logiciels nécessaires à son utilisation auprès de 
l’administrateur de réseau qui supervise son fonctionnement. Avant de commencer, 
identifiez votre administrateur de réseau.
Suivez les instructions ci-après lorsque vous choisissez un câble pour votre réseau :
Connexion à un réseau Ethernet à paires torsadées
Vous pouvez vous connecter directement à un réseau Ethernet 10/100/1000 
à paires torsadées.
Remarque : vous pouvez également connecter votre ordinateur à un réseau Ethernet 
utilisant des câbles coaxiaux fins. Pour cela, procurez-vous un adaptateur coaxial fin 
RJ-45 (disponible auprès d’autres fabricants). Adressez-vous à votre revendeur agréé 
Apple pour plus d’informations sur les adaptateurs de support Ethernet.
Avertissement : par temps d’orage, déconnectez votre modem de la prise 
téléphonique pour éviter qu’il ne soit endommagé par une surcharge de tension.
Type de port Ethernet 
à paires torsadées
Types de câbles 
à paires torsadées à utiliser
10 Mbps Classe 3, 5 ou 6
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Pour connecter votre Macintosh à un réseau centralisé Ethernet 10/100/1000 
à paires torsadées :
1 Connectez l’extrémité d’un câble à paire torsadée RJ-45 au port Ethernet de votre 
Macintosh.
2 Connectez l’autre extrémité à une prise murale RJ-45 ou à un concentrateur externe 
Ethernet RJ-45 relié à un réseau Ethernet à paires torsadées.
Après avoir démarré l’ordinateur, vous devez configurer votre logiciel de connexion au 
réseau. Votre administrateur de réseau peut vous fournir les informations nécessaires. 
Vous pouvez également obtenir de l’aide pour la configuration de votre logiciel de 
réseau en consultant l’Aide Mac OS dans le menu Aide.
Pour configurer les réglages Réseau :
1 Sélectionnez menu Pomme (K) > Préférences Système puis cliquez sur Réseau.
2 Dans le menu local Afficher, sélectionnez Ethernet intégré. 
3 Cliquez sur l’onglet TCP/IP et saisissez les informations concernant votre réseau. 
Par défaut, le réglage est Configurer : Via DHCP.
4 Cliquez sur Appliquer.
Port Ethernet 
(Ethernet à 
paire torsadée)
Prise murale RJ-45
Câble Ethernet 
à paire torsadée
Commutateur ou 
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Informations supplémentaires sur l’utilisation d’Ethernet
Des informations supplémentaires, y compris sur la configuration d’un réseau Ethernet 
ou le transfert de fichiers via Ethernet, sont disponibles dans l’Aide Mac OS. Choisissez 
Aide > Aide Mac, puis recherchez “Ethernet” ou “réseau”. 
Pour plus d’informations sur la mise en réseau de votre Power Mac G5, consultez le 
Support AppleCare à l’adresse www.apple.com/support.
Pour des informations sur les produits de mise en réseau que vous pouvez utiliser 
avec votre Power Mac G5, consultez le Guide des Produits Macintosh à l’adresse 
www.apple.com/guide.
Accès sans fil à Internet et à votre réseau local via AirPort
AirPort constitue une méthode simple et peu coûteuse pour établir un accès sans fil 
à Internet à partir de n’importe quel endroit dans une maison, un bureau ou une salle 
de classe. Au lieu de faire appel à des câbles classiques, AirPort utilise la technologie 
de réseau local (LAN) sans fil permettant une communication sans fil entre plusieurs 
ordinateurs. Un réseau sans fil vous permet d’établir un accès à Internet, de transférer 
des fichiers, de jouer à plusieurs, etc.
Votre Power Mac G5 est préconfiguré pour l’utilisation d’AirPort. La seule chose que 
vous avez à ajouter est une carte AirPort Extreme. Voir “Installation d’une carte AirPort 
Extreme” à la page 69. Vous devez installer cette dernière dans un logement à l’intérieur 
de l’ordinateur, la connecter directement à l’extrémité d’un fil d’antenne intégré et 
installer une antenne AirPort. Pour obtenir des instructions sur l’utilisation de votre carte 
AirPort Extreme, consultez la brochure fournie avec votre carte et intitulée À propos de 
votre carte AirPort Extreme .
Connexions sans fil à un réseau
En installant une carte AirPort Extreme, vous pourrez :
• Connecter votre ordinateur à un réseau disposant d’un accès sans fil.
• Utiliser votre ordinateur pour permettre à d’autres ordinateurs d’accéder au réseau 
à l’aide de cartes de communication sans fil.
• Établir une connexion sans fil et partager des données avec un autre ordinateur 
équipé d’une carte AirPort, une carte sans fil 802.11b ou une carte sans fil 802.11g.
Pour plus d’informations sur la zone de couverture du point d’accès sans fil au réseau, 
adressez-vous à l’administrateur de réseau. 
Si votre ordinateur a été fourni avec une carte AirPort Extreme ou que vous en installez 
une, vous devez également installer dans le port d’antenne AirPort l’antenne AirPort 
fournie avec votre ordinateur( ) à l’arrière de l’ordinateur. Pour toute information 
supplémentaire, consultez la section “Installation d’une carte AirPort Extreme” à la page 69.Fonctionnement de l’accès sans fil à Internet via AirPort
Le système AirPort permet d’établir une connexion sans fil avec un appareil appelé 
borne d’accès qui dispose, lui, d’une connexion physique à Internet. La technologie 
AirPort fonctionne comme un téléphone sans fil. Le combiné du téléphone établit 
une connexion sans fil avec la base qui est reliée à la ligne téléphonique. De même, 
votre ordinateur établit une connexion sans fil avec la borne qui est connectée à la 
ligne téléphonique ou à votre réseau Ethernet.
Remarque : la carte Airport Extreme est compatible avec toutes les versions de la 
borne d’accès Airport.
Important : plusieurs types d’objets placés près de l’ordinateur peuvent provoquer 
des interférences. Pour des informations sur la façon d’éviter les interférences, reportezvous aux instructions accompagnant la carte AirPort Extreme ou la borne d’accès 
AirPort Extreme. Pour plus d’informations, rendez-vous sur le site d’assistance 
AppleCare à l’adresse www.apple.com/support.
Borne d’accès AirPort Extreme
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Informations supplémentaires sur AirPort
Pour acheter une carte ou une borne d’accès AirPort Extreme, rendez-vous dans 
un centre de distribution Apple, contactez votre distributeur agréé Apple ou consultez 
le site Apple Store à l’adresse www.apple.com/store. 
Pour plus d’informations sur AirPort, recherchez le terme “AirPort” dans l’Aide Mac OS. 
Vous pouvez également trouver des informations sur le site Web AirPort d’Apple à 
l’adresse www.apple.com/airport.
Suspension de l’activité de l’ordinateur pour économiser 
l’énergie
Les ordinateurs Power Mac G5 sont configurés de manière à suspendre leur activité 
après une période d’inactivité. La suspension d’activité permet à votre ordinateur de 
consommer un minimum d’énergie. L’activité de l’ordinateur peut être suspendue à 
tout moment.
Remarque : les ordinateurs Power Mac G5 sont réglés pour suspendre leur activité 
automatiquement après 15 minutes d’inactivité. Vous pouvez toutefois modifier les 
réglages de suspension d’activité automatique dans Préférences Système.
À la réactivation de l’ordinateur, vos programmes, documents et réglages d’ordinateur 
réapparaissent exactement tels que vous les aviez laissés. Pour économiser davantage 
d’énergie, éteignez votre ordinateur lorsqu’il n’est pas utilisé.
Vous pouvez utiliser une des méthodes suivantes pour mettre votre ordinateur 
en veille :
• Appuyez sur le bouton d’alimentation situé à l’avant de l’ordinateur.
• Choisissez menu Pomme (K) > Suspendre l’activité.
• Sélectionnez menu Pomme (K) > Préférences Système, cliquez sur Économiseur 
d’énergie et choisissez un délai de suspension d’activité.
Lorsque l’activité de l’ordinateur est suspendue, le témoin d’alimentation situé sur le 
panneau avant clignote.
Pour réactiver l’ordinateur, appuyez sur le bouton d’alimentation en façade ou appuyez 
sur une touche du clavier. Vous pouvez également appuyer sur le bouton d’alimentation 
de certains moniteurs Apple pour suspendre l’activité de l’ordinateur ou le réactiver.
Les cartes PCI ou les cartes de rechange AGP ne sont pas toutes conformes aux normes 
de consommation électrique de l’ordinateur. Si vous installez une carte non-conforme, 
l’ordinateur pourra toujours suspendre son activité, mais il se peut que les économies 
d’énergie obtenues ne soient pas optimales. 
Pour plus d’informations sur les options d’économie d’énergie, consultez l’Aide Mac OS.42 Chapitre 2 Utilisation de votre ordinateur
Transfert d’informations entre deux ordinateurs 
Macintosh
Si deux ordinateurs Macintosh ne sont pas connectés via un réseau Ethernet, AirPort 
ou Bluetooth, vous pouvez transférer des informations de l’un à l’autre en les reliant 
à l’aide d’un câble Ethernet Cat 5 standard (créant ainsi un mini réseau constitué de 
deux ordinateurs). Ce type de câble est disponible auprès d’un revendeur agréé Apple. 
Branchez le câble sur chaque port Ethernet de votre ordinateur et activez le partage 
de fichiers sur les deux ordinateurs. Vous pouvez également configurer les réglages 
Ethernet sur les deux ordinateurs pour créer un petit réseau. 
Vous devez d’abord activer le partage de fichiers sur les deux ordinateurs :
1 Choisissez menu Pomme (K) > Préférences Système.
2 Cliquez sur Partage, puis sur Démarrer.
3 Ouvrez les préférences Réseau, sélectionnez AppleTalk, puis Activer AppleTalk”
Ensuite, procédez comme suit sur un seul ordinateur :
1 Choisissez Aller > “Se connecter au serveur”.
2 Cliquez sur Réseau local.
3 Sélectionnez l’ordinateur auquel vous souhaitez avoir accès.
Pour plus d’informations sur la configuration Ethernet, recherchez “Ethernet“ 
dans l’Aide Mac OS. 
Si vous disposez d’un réseau sans fil Bluetooth ou AirPort, vous pouvez aussi transférer 
des informations entre deux ordinateurs Macintosh. Pour plus d’informations sur les 
réseaux sans fil AirPort ou Bluetooth, recherchez “AirPort” ou “Bluetooth” dans l’Aide 
Mac OS.
Vous pouvez également connecter deux ordinateurs Macintosh à l’aide d’un câble 
FireWire. Cela vous permet d’utiliser le mode disque cible FireWire pour transférer des 
fichiers d’un ordinateur à l’autre. Pour plus d’informations, consultez la section “Mode 
disque cible FireWire” à la page 29.
Si vous disposez d’une connexion à Internet, vous pouvez également transférer des 
fichiers via le Web vers votre iDisk .Mac, d’où ils peuvent être téléchargés par vous 
ou par un autre utilisateur .Mac.3
43
3 Interventions à l’intérieur de 
l’ordinateur
Vous pouvez personnaliser et accroître les capacités 
de votre Power Mac G5 selon vos besoins. 
Ce chapitre fournit des informations et des instructions sur les interventions à l’intérieur 
de votre ordinateur et présente les procédures suivantes :
• “Ouverture de l’ordinateur” à la page 44
• “Installation de mémoire” à la page 49
• “Installation d’unités de stockage internes” à la page 56
• “Installation d’une carte d’extension PCI ou remplacement de la carte AGP” à la 
page 64
• “Installation d’une carte AirPort Extreme” à la page 69
• “Remplacement de la pile” à la page 70
Avertissement : Apple recommande de faire appel à un technicien agréé Apple 
pour l’installation de modules de mémoire, de cartes d’extension PCI et d’unités 
de stockage internes. Consultez les informations relatives à l’assistance et à la 
maintenance fournies avec l’ordinateur pour savoir comment joindre un fournisseur 
de services agréé Apple. Si vous tentez d’installer vous-même ces composants, vous 
risquez d’endommager votre système et les dommages ne seront pas couverts par 
la garantie limitée de votre ordinateur. Adressez-vous à un revendeur ou à un centre 
de maintenance agréé Apple pour toute information complémentaire sur l’étendue 
de la garantie.44 Chapitre 3 Interventions à l’intérieur de l’ordinateur
Ouverture de l’ordinateur
1 Avant d’ouvrir votre ordinateur, éteignez-le en sélectionnant le menu Pomme (K) > 
Éteindre.
2 Patientez 5 à 10 minutes, le temps que les composants internes de l’ordinateur 
refroidissent.
3 Touchez les couvercles métalliques d’accès PCI de l’arrière de l’ordinateur pour décharger 
l’énergie statique que peut emmagasiner votre corps.
Important : veilllez à toujours vous décharger de l’électricité statique que vous êtes 
susceptible d’avoir accumulé avant de toucher ou d’installer tout composant à l’intérieur 
de l’ordinateur. Pour éviter de générer de l’électricité statique, ne vous déplacez pas 
dans la pièce avant d’avoir achevé l’installation du composant concerné et d’avoir 
refermé l’ordinateur.
Avertissement : veillez à toujours éteindre votre Power Mac G5 avant de l’ouvrir pour 
éviter d’endommager ses composants internes ou les composants à installer. N’ouvrez 
pas votre ordinateur et n’essayez pas d’y installer des composants s’il est allumé. 
Avertissement : même une fois votre ordinateur éteint, les composants internes 
peuvent être très chauds. Laissez refroidir l’ordinateur avant de continuer. 
Touchez la partie 
métallique des capots 
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4 Débranchez tous les câbles de l’ordinateur, excepté le câble d’alimentation.
5 Tenez le panneau latéral et soulevez le loquet à l’arrière de l’ordinateur. 
Avertissement : débranchez toujours votre Power Mac G5 pour éviter d’endommager 
ses composants internes ou ceux que vous souhaitez installer. N’essayez pas d’installer 
des composants dans l’ordinateur quand il est branché.
Tout en maintenant le 
panneau latéral, soulevez 
la languette.46 Chapitre 3 Interventions à l’intérieur de l’ordinateur
6 Enlevez le panneau latéral.
Important : lorsque vous ôtez le panneau latéral, tenez-le fermement.
Écartez la partie supérieure du panneau de l’ordinateur 
et soulevez-la pour l’extraire.Chapitre 3 Interventions à l’intérieur de l’ordinateur 47
7 Démontez le déflecteur d’air et placez-le sur un tissu doux et propre.
Important : n’oubliez pas de replacer le déflecteur d’air à la fin de l’intervention 
à l’intérieur de l’ordinateur. Votre ordinateur ne fonctionnera pas correctement 
sans le déflecteur d’air.
Pour retirer l’extracteur d’air 
de l’ordinateur, soulevez-le 
et ôtez-le en tirant au niveau 
de l’alvéole.48 Chapitre 3 Interventions à l’intérieur de l’ordinateur
8 Tirez le ventilateur de façade par la poignée pour l’enlever de l’ordinateur. Mettez-le 
de côté. 
Remarque : il est inutile de démonter le ventilateur de façade pour installer des disques 
durs, des cartes PCI et AGP, ou pour remplacer la pile.
Retirez le ventilateur 
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Installation de mémoire
Selon le modèle, votre Power Mac G5 est doté de quatre ou huit logements pour 
modules DIMM de mémoire SDRAM DDR. Votre ordinateur est fourni avec au minimum 
256 Mo de mémoire RAM, installée sous forme d’une paire de modules DIMM de 128 Mo 
dans deux des logements DIMM. Vous pouvez installer des paires supplémentaires de 
DIMM dans les logements DIMM disponibles sur la carte mère de votre ordinateur.
Les modules DIMM doivent être installées par paires de capacité identique et se 
conformer aux caractéristiques suivantes : 
• 400 MHz, PC 3200 DIMM
• 2,5 volts (V)
• Module 184 broches
• Nombre maximal d’éléments de mémoire sur la SDRAM DDR : 16
• Sans parité
• Sans code de correction d’erreurs
• Sans tampon ; n’utilisez pas de SDRAM DDR enregistrée ou avec tampon.
Important : il se peut que la mémoire provenant d’anciens ordinateurs Macintosh 
ne soit pas compatible avec votre Power Mac G5. 
Remarque : lorsque vous achetez de la mémoire SDRAM DDR pour ordinateurs 
Macintosh, assurez-vous qu’elle est conforme aux spécifications JEDEC (Joint Electron 
Device Engineering Council). Vérifiez auprès de votre vendeur que la mémoire SDRAM 
DDR gère les modes d’horloge adéquats et que la fonction SPD (Serial Presence Detect) 
a été correctement programmée, conformément aux spécifications JEDEC. Pour vérifier 
la comptabilité de vos modules DIMM SDRAM DDR, consultez le guide des produits 
Macintosh sur le site Web d’Apple, à l’adresse www.apple.com/guide. Vous pouvez 
acheter de la mémoire de marque Apple sur le site Web Apple Store, à l’adresse 
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Pour installer de la mémoire :
1 Ouvrez votre ordinateur, démontez le panneau latéral, le déflecteur d’air et le 
ventilateur en suivant les instructions commençant la page 44.
2 Localisez les logements DIMM dans l’ordinateur.
Important : installez toujours les DIMM par paires de capacité égale et dans l’ordre 
indiqué par l’illustration ci-dessus. 
Quel que soit le nombre de logements 
de mémoire SDRAM fourni avec votre
ordinateur, les modules DIMM SDRAM 
doivent être installés par pair (un DIMM 
par banque).
Des modules DIMM sont déjà installés dans ces deux logements. 
Installez d’abord les modules 
supplémentaires dans les deux 
logements suivants.
Si des logements sont disponibles et 
que vous désirez plus de mémoire, installez les modules DIMM 
supplémentaires de la même manière : par pairs, un par banque, 
du centre vers l’extérieur.
Banque 1
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3 Ouvrez les éjecteurs des logements DIMM en les écartant.
4 Placez une main à l’arrière de l’ordinateur pour le maintenir, positionnez le premier 
DIMM dans le logement et poussez les deux extrémités du DIMM vers le bas jusqu’à ce 
que les languettes soient en position verticale et que les éjecteurs reprennent leur place. 
Important : ne touchez pas aux connecteurs du module DIMM. Manipulez le module 
DIMM en le tenant uniquement par les bords.
5 Positionnez le second DIMM dans le logement opposé et poussez jusqu’à ce que les 
éjecteurs reprennent leur place.
Modules DIMM DDR SDRAM
(La forme et les composants des modules DIMM 
peuvent varier.)
L'insertion des modules DIMM DDR SDRAM dans le 
logement ne s’effectue que de la manière suivante : 
alignez l’entaille du module DIMM avec l’épaulement 
situé à l’intérieur du logement, puis une fois les 
éjecteurs ouverts (comme illustré ci-contre), 
enfoncez le module DIMM jusqu'à ce qu'il se 
mette en place. Les éjecteurs se ferment 
alors automatiquement.
Connecteurs Entaille Logement DDR SDRAM
Éjecteurs
(Ils doivent être enfoncés vers l’extérieur, comme 
indiqué ci-dessus, pour être en position fermée.) 
Pour vous assurer que les modules DIMM sont correctement 
installés dans leur logement, maintenez d’une main l’ordinateur 
afin d’empêcher tout mouvement de ce dernier, puis enfoncez 
fermement avec l’autre main le module DIMM dans son logement.
Votre ordinateur est équipé de 4 ou 8 
logements DDR SDRAM, selon le modèle.
Épaulement 
(à l’intérieur du logement)52 Chapitre 3 Interventions à l’intérieur de l’ordinateur
6 Replacez le ventilateur de façade en le repoussant fermement dans l’ordinateur 
via la poignée, jusqu’à connexion.
Important : vérifiez que le ventilateur est inséré dans le connecteur sous peine que 
votre ordinateur ne fonctionne pas correctement. Tirez légèrement sur le ventilateur 
pour voir s’il est correctement connecté. S’il résiste et reste en place, c’est qu’il est 
correctement branché.
Glissez la saillie en plastique du ventilateur 
dans la partie découpée de la cloison métallique
située à l’intérieur de l’ordinateur. Le ventilateur
doit être inséré dans ce connecteur.Chapitre 3 Interventions à l’intérieur de l’ordinateur 53
7 Replacez le déflecteur d’air. 
Important : n’oubliez pas de replacer le déflecteur d’air. Votre ordinateur ne fonctionnera 
pas correctement si le déflecteur d’air n’est pas en place.
Insérez les trois languettes du déflecteur d’air dans les 
logements prévus à cet effet, puis mettez-le en place.54 Chapitre 3 Interventions à l’intérieur de l’ordinateur
8 Replacez le panneau latéral.
Important : replacez toujours le panneau latéral avant de démarrer votre ordinateur. 
Votre ordinateur ne fonctionnera pas correctement si le panneau latéral n’est pas 
en place.
Insérez le panneau latéral dans le logement de l’ordinateur
prévu à cet effet, puis remettez en place le panneau latéral.Chapitre 3 Interventions à l’intérieur de l’ordinateur 55
9 Poussez le loquet vers le bas pour verrouiller le panneau latéral.
Important : lorsque vous replacez le panneau latéral, maintenez-le bien de façon 
qu’il reste bien en place lorsque vous abaissez le loquet.
Tout en maintenant le panneau latéral 
contre l’ordinateur, abaissez le loquet 
jusqu’à ce qu’il soit bien fixé à l’arrière 
de l’ordinateur.
Pour verrouiller le panneau latéral ou 
par mesure de sécurité, abaissez la languette 
de verrouillage avant de fermer le loquet, 
de manière à pouvoir fixer un verrou ou 
un câble à la boucle métallique.56 Chapitre 3 Interventions à l’intérieur de l’ordinateur
Installation d’unités de stockage internes
Votre Macintosh dispose de trois baies d’unités internes : une baie de lecteur optique 
et deux baies de disque dur. Dans la plupart des configurations, un disque dur occupe 
la baie de disque dur du haut et un lecteur optique se trouve dans la baie de lecteur 
optique de devant. 
Vous pouvez ajouter un disque dur Serial ATA dans le logement vide de la baie 
de disque dur. Les disque durs doivent respecter les spécifications suivantes :
• Type : serial ATA
• Largeur : 102 mm (3,9 pouces)
• Profondeur : 147 mm (5,7 pouces)
• Hauteur : 25,4 mm (1 pouce) 
Important : utilisez les câbles Apple d’origine fournis avec votre Macintosh quand 
vous installez des disque durs ATA ou des lecteurs optiques. 
Pour plus d’informations sur les conditions requises et les périphériques compatibles, 
consultez votre distributeur agréé Apple et la section d’assistance technique du site 
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Installation de disques durs Serial ATA
Votre Macintosh peut accueillir un disque dur Serial ATA supplémentaire d’une hauteur 
de 25,4 mm (1 pouce ) dans la baie de disque dur, soit un total de deux disques durs. 
Votre ordinateur est fourni avec un disque dur Serial ATA, généralement dans la baie 
de disque dur du haut. Vous pouvez installer un deuxième disque dur Serial ATA dans 
la baie de disque dur inférieure.
1 Ouvrez votre ordinateur et ôtez le panneau latéral en suivant les instructions 
commençant la page 44.
2 Dévissez les quatre guides de disque dur du côté gauche de la baie de disque dur 
et vissez-les sur les côtés du disque dur comme illustré ci-dessus.
Important : si la carte à circuit imprimé est visible au-dessous du disque dur, tenez le 
disque par ses côtés. Pour éviter d’endommager le disque dur, ne touchez pas le circuit 
imprimé pendant l’installation.
Insérez les quatre guides 
de l’unité dans quatre des trous
taraudés sur les côtés de celle-ci. 
Utilisez, si possible, les trous situés 
aux coins.
Pour pouvoir relier les câbles d’alimentation
et de données, l’unité doit être dotée 
de ces connecteurs en forme de lame.
Certaines unités peuvent également 
être équipées de connecteurs en forme 
de broche. Ceux-ci ne permettent pas 
la connexion de câbles.
Les quatre guides de l’unité 
se trouvent sur la cloison 
en plastique à côté des baies 
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3 Pour installer un disque dur supplémentaire, glissez-le dans la baie de disque inférieure, 
en insérant les guides du disque dur dans les rails du bas, et poussez doucement le 
disque dur jusqu’à ce qu’il soit en place.
4 Pour remplacer le disque dur dans la baie de disque supérieure, retirez de celle-ci le 
disque dur d’origine et faites-le glisser légèrement vers le bas jusqu’à ce que la baie 
de disque soit vide. Faites glisser le disque de remplacement dans la baie de disque 
supérieure, en insérant les guides du disque de devant dans le rail du milieu. 
Enclenchez les guides du disque de derrière dans le rail supérieur à mesure que le 
disque s’emboîte dans la baie de disque. Poussez doucement le disque dans la baie 
jusqu’à ce qu’il soit en place.
Insérez les guides du disque dur dans le rail inférieur 
et glissez le disque jusqu'à ce qu’il soit en place.
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Remarque : si un disque dur est installé dans la baie de disque inférieure, retirez-le 
avant de remplacer le disque dur de la baie de disque supérieure.
5 Abaissez la languette de la baie de disque pour verrouiller le disque dur.
6 Reliez au disque dur le câble d’alimentation et le câble de données Serial ATA.
7 Replacez le panneau latéral en suivant les instructions qui commencent la page 54.
Pour installer un lecteur de remplacement dans la baie supérieure du disque 
dur, placez les guides avant dans les rails du milieu et enfoncez le lecteur. 
Les guides arrière doivent suivre les rails supérieurs au fur et à mesure de son 
installation dans la baie. Glissez le lecteur jusqu'à ce qu’il se mette en place et 
consolidez son installation à l’aide de la languette de la baie supérieure.
Guides du disque dur 
Connectez le câble d’alimentation et le câble de données 
au lecteur du disque dur. 
Afin de consolider l’installation du disque dur, 
rabaissez la patte des baies jusqu'à ce qu'elle soit 
en position fermée (horizontale).
Reliez le câble d’alimentation et celui des données 
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Remplacement du lecteur optique
Votre ordinateur est fourni avec un lecteur optique, de type SuperDrive ou Combo. 
Suivez ces instructions pour replacer le lecteur optique dans la baie de lecteur optique. 
Important : pour savoir si votre lecteur est réglé pour le mode de sélection par câble, 
adressez-vous au fabricant ou visitez son site Web. Avant l’installation, réglez le lecteur 
sur la sélection par câble si cela n’a pas été fait par le fabricant.
1 Ouvrez votre ordinateur et ôtez le panneau latéral en suivant les instructions qui 
commencent la page 44.
2 Débranchez le câble en nappe du lecteur optique de la carte mère.
3 Relevez les leviers du lecteur optique pour le libérer.
Avant d’extraire le lecteur optique, déconnectez 
ce câble de la carte mère.
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4 Glissez soigneusement une partie du lecteur en dehors de la baie. 
5 Débranchez le câble en nappe au dos du lecteur d’origine et tirez doucement sur le 
câble via l’ouverture dans la cloison métallique à l’arrière de la baie de lecteur optique. 
6 Insérez deux ou trois doigts dans l’ouverture à l’arrière de la baie de lecteur optique 
et repoussez le lecteur légèrement pour pouvoir le retirer de l’ordinateur.
7 Débranchez le câble d’alimentation du lecteur.
8 Dévissez les quatre tenons de guidage situés au-dessous du lecteur optique d’origine 
et positionnez-les au-dessous du lecteur de remplacement.
9 Retirez la protection métallique à l’avant du lecteur et positionnez-la à l’avant 
du lecteur de remplacement.
Retirez la protection métallique 
du lecteur optique.
Retirez les quatre tenons 
de guidage métalliques 
du lecteur optique situés 
au-dessous de celui-ci.
Retirez le câble 
d’alimentation de l’arrière
du lecteur optique.
Retirez le lecteur de la baie en insérant deux doigts
dans l’ouverture du câble en nappe et en poussant
sur le lecteur.
Retirez le câble en nappe de l’arrière du lecteur 
optique. Glissez l’autre extrémité du câble à travers 
l’ouverture de la cloison métallique située 
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10 Débranchez soigneusement le câble en nappe du haut du lecteur d’origine et 
rebranchez-le sur le lecteur de remplacement.
Important : placer de la bande adhésive réutilisable sur le dessous du câble en nappe 
permet de maintenir le câble sur le lecteur. Lors de la déconnexion du câble du lecteur 
d’origine, veillez à conserver la bande avec le câble.
11 Branchez le connecteur du câble en nappe et le câble d’alimentation à l’arrière du 
lecteur de remplacement.
12 Insérez partiellement le lecteur dans la baie de disque, pliez l’extrémité libre du câble 
en nappe, et passez-la dans l’ouverture de la cloison métallique à l’arrière de la baie 
de lecteur optique.
Installez la protection métallique
sur le lecteur optique.
Insérez les quatre tenons de guidage 
métalliques du lecteur optique 
dans la partie inférieure de celui-ci.
Reliez le câble d’alimentation à la partie
arrière du lecteur optique.
Reliez le câble en nappe à la partie arrière du 
lecteur optique. Glissez l’autre extrémité 
de ce câble (vers le bas) à travers l’ouverture 
de la cloison métallique située à l’intérieur de
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13 Glissez le reste du lecteur dans la baie de disque en l’alignant avec les tenons de 
guidage, et poussez doucement le lecteur en place.
14 Lorsque le lecteur est installé correctement, les leviers du lecteur optique se referment. 
S’ils ne se referment pas, appuyez doucement dessus. 
15 Reliez le câble en nappe du lecteur optique à son connecteur sur la carte mère. 
16 Replacez le panneau latéral en suivant les instructions qui commencent la page 54.
Pour installer le lecteur optique, enfoncez-le de sorte 
à ce que les broches d’alignement s’insèrent dans les quatre
logements de l’ordinateur. Une fois l’installation terminée, 
fermez les leviers du lecteur optique.
Reliez à nouveau le câble au connecteur 
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Installation d’une carte d’extension PCI ou remplacement 
de la carte AGP
Vous pouvez accroître les capacités de votre Power Mac G5 en installant des cartes 
dans ses logements d’extension. Votre Power Mac G5 dispose de quatre logements de 
cartes d’extension : trois réservés aux cartes PCI (Peripheral Component Interconnect) 
et un destiné à accueillir une carte AGP (Advanced Graphics Port).
Les cartes AGP et PCI étant munies de connecteurs différents, vous ne pouvez pas 
insérer une carte PCI dans un logement destiné à une carte AGP.
À propos des cartes AGP
Votre carte AGP, installée dans le logement 1, contient l’unité de processeur graphique 
(GPU - graphics processor unit) et fournit les ports du moniteur de l’ordinateur. Le 
logement 1 est spécialement conçu pour accueillir les cartes AGP. Ce logement à 533 
mégahertz (MHz) abrite les cartes AGP à 1,5 volt (V) (voir l’illustration la page 67).
Vous pouvez remplacer la carte fournie avec votre ordinateur par une carte AGP 8X 
ou AGP 8X Pro. Les cartes AGP de rechange doivent disposer de pilotes compatibles 
Mac OS X.
À propos des cartes d’extension PCI
Votre Macintosh compte trois logements d’extension (numéros 2, 3 et 4) qui acceptent 
des cartes d’une longueur maximale de 30 mm (12 pouces). Selon le modèle de votre 
Power Mac G5, vous pouvez installer des cartes PCI ou PCI-X. 
Type de carte prise en charge Logement Vitesse de la carte
PCI1 logements 2, 3 et 4 64 bits, 33 MHz
PCI-X logements 2 et 3 
logement 4
64 bits, 100 MHz 
64 bits, 133 MHz
1Les logements PCI peuvent contenir des cartes de différentes tensions (5,0 V, 12 V ou 3,3 V), mais uniquement en 
signalisation 3,3 V, avec des tailles de données de 32 ou 64 bits et une fréquence de 33 MHz. Vous pouvez installer 
une carte cadencée à 66 MHz dans un logement PCI 33 MHz si la carte fonctionne également à la fréquence 
inférieure de 33 MHz.
Avertissement : n’installez pas dans les logements PCI 33 MHz de cartes PCI ne 
fonctionnant qu’à 66 MHz : cela risquerait d’endommager votre matériel. Si vous avez 
une carte PCI fonctionnant à 66 MHz, vérifiez auprès de son fabricant qu’elle peut 
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La quantité totale d’énergie consommée par les quatre logements d’extension (les trois 
cartes d’extension PCI et la carte AGP) ne doit pas excéder 90 watts (W). 
Pour savoir si votre ordinateur dispose de logements PCI ou PCI-X, lisez l’étiquette 
d’identification, située sur le côté de l’ordinateur, en bas, sous le déflecteur d’air. Vous 
pouvez aussi identifier votre modèle en fonction du nombre de logements DIMM. Les 
ordinateurs dotés de 4 logements DIMM ont des logements PCI 33 MHz ; les ordinateurs 
dotés de 8 logements DIMM disposent de logements PCI-X 100 et 133 MHz.
L’étiquette d’identification 
de votre ordinateur vous 
propose des informations 
sur la configuration matérielle. 
Elle contient des codes et 
présente la même forme que 
l’étiquette illustrée ci-dessous. 
Si votre ordinateur est équipé 
de logements PCI-X, il sera 
répertorié dans la présente 
liste. Dans le cas contraire, 
il est alors doté de logements 
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Installation de votre carte
Vous pouvez installer une carte AGP uniquement dans le logement 1. Le logement AGP 
accepte des cartes AGP ou AGP Pro standard. Vous pouvez indifféremment installer des 
cartes PCI ou PCI-X dans les logements PCI 2, 3 et 4. Voir le tableau de la page 64.
1 Ouvrez votre ordinateur et ôtez le panneau latéral et le déflecteur d’air en suivant les 
instructions de la page 44.
2 Enlevez la vis du capot d’accès aux ports, retirez le capot et mettez-le de côté.
Remarque : pour éviter que les vis du capot d’accès PCI tombent dans le boîtier, 
employez un tournevis magnétique, disponible dans la plupart des magasins 
d’électronique. Attention à ne pas placer le tournevis magnétique près des 
disques durs ou de support tels que CD ou DVD.
Avertissement : éteignez et débranchez toujours votre Power Mac G5 pour éviter 
d’endommager ses composants internes ou ceux que vous souhaitez installer. 
Attendez 5 ou 10 minutes pour qu’il refroidisse. N’essayez pas d’y installer des 
composants quand il est branché.
Capot d’accès aux ports
Enlevez la vis qui maintient 
en place le capot d’accès 
aux ports.
Si vous devez retirer la carte 
du logement AGP, faites en sorte 
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3 Sortez la carte à installer de son sachet antistatique en la tenant par les coins 
et en veillant à ne toucher ni le connecteur en or, ni aucun des composants.
4 Alignez le connecteur de la carte sur le logement d’extension, puis appuyez vers le bas 
jusqu’à ce que le connecteur soit enclenché.
Si vous installez une carte de 30 mm (12 pouces), assurez-vous que la carte est engagée 
dans le guide approprié.
Ouverture d’accès au port
Logement PCI
Remettez la vis afin de
consolider l’installation 
de la carte.
Si vous installez une 
carte PCI pleine longeur 
(12 pouces), veillez à 
ce qu’elle tienne dans 
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Appuyez sur la carte délicatement mais fermement jusqu’à ce que le connecteur soit 
complètement enclenché.
• Ne balancez pas la carte d’un côté à l’autre. Enfoncez-la verticalement dans le 
logement. 
• Insérez la carte sans forcer. En cas de résistance, retirez la carte. Vérifiez si le 
connecteur et le logement sont endommagés ou obstrués, puis essayez à nouveau.
• Tirez légèrement sur la carte pour voir si elle est correctement connectée. Si elle 
résiste, reste en place et que ses connecteurs en or sont à peine visibles, la carte 
est connectée. 
5 Réinsérez la vis du capot d’accès aux ports, puis serrez-la afin de maintenir la carte 
en place.
6 Replacez le déflecteur d’air et le panneau latéral, en suivant les instructions la page 53.
Avertissement : si vous retirez une carte sans en installer une autre, veillez à recouvrir 
le logement vide au moyen d’un capot d’accès aux ports. Les capots permettent 
d’empêcher l’entrée d’objets étrangers dans l’enceinte. Un logement non couvert 
peut affecter la circulation d’air qui refroidit les composants internes de l’ordinateur 
et causer des dommages.Chapitre 3 Interventions à l’intérieur de l’ordinateur 69
Installation d’une carte AirPort Extreme
AirPort permet d’accéder sans fil à Internet en toute simplicité ; cela sans vous ruiner et 
n’importe où, que ce soit chez vous, au bureau ou dans un établissement scolaire. Vous 
pouvez installer une carte AirPort Extreme sur votre Power Mac G5.
Important : vous devez installer une carte AirPort Extreme. Les anciennes cartes Airport 
ne fonctionnent pas dans le Power Mac G5.
1 Ouvrez votre ordinateur conformément aux instructions de la page 44.
2 Positionnez la carte Airport Extreme avec le logo Apple vers le haut, insérez la carte 
dans le logement et enfoncez-la fermement dans le connecteur.
3 Connectez avec soin le câble coaxial de l’antenne au port de l’extrémité de la carte 
AirPort Extreme.
Insérez la carte AirPort 
Extreme (le logo Apple vers 
le haut) dans le logement 
prévu à cet effet. Enfoncez-la 
fermement dans le connecteur.
Branchez le câble de 
l’antenne dans l’orifice 
situé à l’extrémité de 
la carte AirPort Extreme.
Le logement de la carte 
AirPort Extreme se trouve 
sous la cloison métallique.
Le câble de l’antenne de la carte 
AirPort Extreme est fixé sous la cloison 
métallique à l’aide d’une agraphe. 
Retirez-la avant de relier le câble 
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4 Replacez le ventilateur, le déflecteur d’air et le panneau latéral, en suivant les instructions 
la page 52.
5 Reliez l’antenne AirPort Extreme au port d’antenne Airport ( ) sur le panneau arrière. 
Pour régler la réception, faites pivoter l’antenne.
Remplacement de la pile
Votre ordinateur dispose d’une pile au lithium de 3,6 V placée sur la carte mère. 
Si vous constatez des problèmes intermittents de démarrage de l’ordinateur ou des 
changements aléatoires de date et d’heure, il est peut-être temps de changer cette pile. 
Achetez une pile de rechange chez un revendeur agréé Apple.
Important : les piles contiennent des substances chimiques dont certaines sont 
néfastes pour l’environnement. Veillez à respecter les directives et la législation en 
vigueur dans votre pays en matière de protection de l’environnement lorsque vous 
vous débarrassez des piles usagées.
Avertissement : les règlements FCC prévoient que l’opérateur ou toute autre 
personne soit à plus de 1 centimètre (0,4 pouce) de l’antenne AirPort Extreme 
pendant la transmission. De plus, l’antenne AirPort Extreme ne doit pas être située 
près d’un autre transmetteur ou d’une autre antenne, à l’exception du modèle 
d’antenne Apple Bluetooth A1067.
Installez l’antenne AirPort 
dans le port prévu à cet effet.
Vous pouvez la faire pivoter 
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Pour remplacer la pile :
1 Ouvrez votre ordinateur conformément aux instructions de la page 44.
2 Si une carte PCI est installée à côté de la pile, retirez la carte.
3 Enlevez la pile de son réceptacle en notant le sens des pôles. (Un signe plus figure 
sur le réceptacle ou à côté de ce dernier.)
Si nécessaire, écartez les languettes qui retiennent la pile afin de pouvoir la retirer. 
Écartez les languettes doucement pour ne pas les casser.
4 Introduisez la pile neuve dans le réceptacle en vous assurant que le signe plus 
de la pile coïncide avec le signe plus du réceptacle.
5 Replacez le déflecteur d’air et le panneau latéral, en suivant les instructions qui 
commencent à la page 53.
Sortez la pile de son réceptacle 
en la tirant vers le haut. Il peut 
s’avérer nécessaire d’écarter 
légèrement ces languettes.
Avertissement : une mise en place incorrecte de la pile peut provoquer une explosion. 
Assurez-vous de respecter la position des pôles. Utilisez uniquement une pile du 
même type ou une pile équivalente approuvée par le fabricant de la pile d’origine.4
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4 Dépannage 
En cas de problèmes de fonctionnement de l’ordinateur, 
voici quelques suggestions susceptibles d’y remédier. 
Si l’ordinateur ne répond pas ou que le pointeur est bloqué.
Assurez-vous tout d’abord que la souris et le clavier sont connectés.
• Débranchez puis rebranchez les connecteurs et vérifiez qu’ils sont correctement 
insérés.
Essayez ensuite d’annuler l’opération en cours.
• Appuyez simultanément sur les touches Commande (x) et Q pour essayer de fermer 
l’application en cours d’exécution. 
• Appuyez simultanément sur les touches Commande (x) et point. Si une boîte de 
dialogue apparaît, cliquez sur Annuler. 
• Sous Mac OS X, sélectionnez menu Pomme (K) > “Forcer à quitter”, puis sélectionnez 
l’application que vous souhaitez fermer. Redémarrez l’ordinateur en allant dans le 
menu Pomme (K) > Redémarrer pour être sûr que le problème est complètement 
résolu. Il est aussi possible de forcer l’application à quitter en appuyant 
simultanément sur les touches Échap + Option + Commande (x).
• Sous Classic, appuyez simultanément sur les touches Échap + Option + Commande 
(x) pour forcer une application à quitter. 
• Si cela ne fonctionne pas, maintenez appuyé durant 5 secondes le bouton 
d’alimentation de la face avant de l’ordinateur. Après la mise hors tension de 
l’ordinateur, appuyez à nouveau sur ce bouton pour redémarrer.
• En dernier recours, débranchez le câble d’alimentation pour éteindre l’ordinateur, 
puis rebranchez-le à nouveau et utilisez le bouton d’alimentation de la face avant 
pour redémarrer l’ordinateur.
• Si le problème ne survient que lorsque vous utilisez un programme en particulier, vérifiez 
auprès de son fabricant s’il est compatible avec votre ordinateur.
• Si le problème survient fréquemment, sélectionnez Aide > Aide Mac. 
• Sous Mac OS X, recherchez “dépannage”.
• Dans Classic, consultez la section expliquant comment éviter et résoudre les 
problèmes. Envisagez également le problème des conflits d’extension.74 Chapitre 4 Dépannage
L’ordinateur ne démarre pas ou ne s’allume pas.
Assurez-vous que le câble d’alimentation est branché sur une prise électrique en état 
de fonctionnement. La fiche du câble d’alimentation doit être totalement insérée dans 
la prise de l’ordinateur pour que celui-ci fonctionne correctement.
Réinitialisez ensuite la mémoire vive des réglages de l’ordinateur (PRAM). Allumez 
l’ordinateur et maintenez immédiatement les touches Commande (x)+ Option + P + R 
enfoncées jusqu’à ce que vous entendiez une deuxième fois le signal sonore de démarrage. 
Définissez ensuite votre disque dur comme disque de démarrage de l’ordinateur. 
m
Sélectionnez menu Pomme (K) > Préférences Système et cliquez sur Disque de démarrage, 
puis sélectionnez votre disque dur.
Le voyant d’état clignote et l’ordinateur ne démarre pas.
• Si vous avez récemment ajouté de la mémoire, une carte d’extension PCI ou tout 
autre composant interne, assurez-vous qu’il est correctement installé et compatible 
avec votre ordinateur. Essayez de l’enlever pour savoir si l’ordinateur peut démarrer.
• Si le voyant d’état continue à clignoter, déterminez le nombre de clignotements pour 
identifier le problème :
• 2 clignotements : RAM absente
• 3 clignotements : RAM installée incompatible
• 4 clignotements : banques DIMM incorrectes
• 5 ou 6 clignotements : contactez un fournisseur de services agréé Apple.
Impossible d’éjecter un disque.
Un fichier est peut-être en cours d’utilisation sur ce disque. Quittez toutes les 
applications ouvertes, puis essayez à nouveau.
Si cela ne fonctionne pas, sélectionnez menu Pomme (K) > Redémarrer et maintenez 
enfoncé soit le bouton de la souris soit la touche d’éjection ( ) de votre clavier 
Apple Keyboard.
Si le problème persiste :
1 Éteignez l’ordinateur.
2 Appuyez doucement sur le panneau protégeant le plateau du lecteur et repérez 
le petit orifice situé sous le plateau.
3 Insérez avec précaution l’extrémité d’un grand trombone déplié dans cet orifice.
4 Poussez fermement jusqu’à ce que le plateau s’ouvre.
5 Tirez sur le plateau pour l’ouvrir, retirez le disque et repoussez le plateau pour le fermer.Chapitre 4 Dépannage 75
Problèmes de logiciels
Important : pour utiliser les applications Mac OS 9 avec votre ordinateur, vous devez 
installer la gestion de Classic (voir “Installation de la gestion de Classic et d’autres 
applications” à la page 79). Pour démarrer l’environnement Classic, ouvrez une 
application Mac OS 9 ou double-cliquez sur un document qui en nécessite une. 
Classic fonctionne en arrière-plan pour permettre l’accès aux fonctionnalités et 
applications Mac OS 9.
Vous rencontrez un problème avec une application.
• Utilisez la mise à jour de logiciels afin de vous assurer que vous disposez des tous 
derniers pilotes, débogueurs et autres mises à jour.
• Pour les problèmes liés aux logiciels provenant d’éditeurs tiers, contactez l’éditeur 
concerné.
Vous rencontrez un problème de fonctionnement de votre ordinateur ou de 
Mac OS X.
• Consultez l’Aide Mac OS (dans le menu d’Aide) pour obtenir des instructions 
et des informations de dépannage.
• Pour obtenir les informations de dépannage et les mises à jour de logiciels les plus 
récentes, rendez-vous sur le site Web de l’assistance Apple à l’adresse suivante : 
www.apple.com/support.
Vous éprouvez des difficultés à utiliser la communication sans fil AirPort.
• Vérifiez que vous avez correctement configuré le logiciel en respectant les 
instructions fournies avec la carte AirPort Extreme ou la borne d’accès AirPort.
• Vérifiez que l’ordinateur ou le réseau auquel vous souhaitez vous connecter est 
activé et dispose d’un point d’accès sans fil.
• Assurez-vous que l’autre ordinateur ou le point d’accès au réseau se trouve dans 
la zone de couverture de l’antenne de votre ordinateur. Des appareils électroniques 
ou des structures métalliques se trouvant à proximité peuvent interférer avec les 
communications sans fil et réduire la portée de votre antenne. Vous pouvez 
éventuellement améliorer la réception en réorientant l’ordinateur.
• Vérifiez la puissance du signal AirPort. Il est possible que l’icône d’état AirPort de la 
barre des menus indique quatre barres.
• Pour plus d’informations, veuillez lire les instructions fournies avec votre périphérique 
sans fil ou effectuer une recherche “AirPort” dans l’Aide Mac OS.76 Chapitre 4 Dépannage
Problèmes de moniteur
Aucune image ne s’affiche à l’écran.
• Assurez-vous que le moniteur et l’ordinateur sont sous tension.
• Vérifiez que les câbles sont correctement connectés à l’ordinateur et au moniteur.
• Assurez-vous que votre ordinateur n’est pas en veille. Appuyez sur le bouton 
d’alimentation ou sur n’importe quelle touche pour voir si cela réactive l’ordinateur. 
• Assurez-vous que la luminosité et le contraste du moniteur sont réglés correctement. 
Certains moniteurs disposent de commandes de luminosité et de contraste situées 
sur ou sous leur face avant.
• Réinitialisez la mémoire des paramètres (PRAM) en redémarrant l’ordinateur tout en 
maintenant les touches Commande (x) + Option + P + R enfoncées, jusqu’à ce que 
vous entendiez une deuxième fois le signal de démarrage. Démarrez alors en 
utilisant le disque d’installation du logiciel fourni avec l’ordinateur.
L’image à l’écran est sombre ou vacillante.
• Réglez la luminosité et le contraste. Certains moniteurs disposent de commandes 
de luminosité et de contraste situées sur ou sous leur face avant. Si besoin est, 
vous pouvez ajuster la luminosité ou le contraste de votre moniteur dans la fenêtre 
Moniteurs des Préférences Système.
• Calibrez le moniteur en sélectionnant menu Pomme (K) > Préférences Système. 
Cliquez sur Moniteurs, sélectionnez Couleur puis cliquez sur Calibrer.
• Il se peut que le vacillement soit dû à des interférences provoquées par la proximité 
d’une ligne électrique, d’une lampe fluorescente ou d’un appareil électrique tel qu’une 
radio, un four à micro-ondes ou un autre ordinateur. Essayez de trouver un autre endroit 
pour les appareils électriques situés à proximité ou de déplacer le moniteur 
et l’ordinateur.
Les couleurs n’apparaissent pas à l’écran ou présentent un aspect inhabituel.
• Assurez-vous que le moniteur est correctement connecté à l’ordinateur.
• Calibrez votre moniteur comme décrit précédemment. Consultez l’Aide Mac OS 
pour en savoir plus sur les couleurs et sur votre moniteur.
• Ouvrez la fenêtre Moniteurs des Préférences Système et vérifiez que votre moniteur 
est réglé pour afficher les couleurs. Consultez l’Aide Mac OS pour en savoir plus sur 
les couleurs et sur votre moniteur.
Avertissement : si vous rencontrez un problème avec votre moniteur Apple Display 
et que vous ne parvenez pas à le résoudre à l’aide de ce manuel, sollicitez l’assistance 
d’un fournisseur de services agréé Apple ou d’Apple. Si vous tentez de le réparer 
vous-même, les dommages éventuels ne seront pas couverts par la garantie limitée 
de votre moniteur. Adressez-vous à un revendeur ou à un centre de maintenance 
agréé Apple pour toute information complémentaire sur l’étendue de la garantie.Chapitre 4 Dépannage 77
Les icônes du bureau changent de place après la modification de la résolution 
d’écran.
Toute modification de la résolution d’écran affecte l’affichage des informations à l’écran. 
Une fois la résolution d’écran modifiée, le système d’exploitation est susceptible de 
réorganiser les icônes.
Écran figé.
• Forcer l’application bloquée à quitter. Allez dans le menu Pomme (K), cliquez sur 
“Forcer à quitter” puis sélectionnez l’application à fermer.
• Si cela ne fonctionne pas, forcez l’ordinateur à redémarrer en enfonçant environ 5 
secondes le bouton d’alimentation de sa face avant. 
Le voyant situé sur la face avant du moniteur clignote.
Sur certains moniteurs à écran plat Apple, le témoin d’alimentation clignote 
rapidement pendant quelques instants lorsqu’une erreur a été détectée. 
• Si vous voyez une séquence répétée de trois flashs courts, cela signifie que le moniteur 
détecte une entrée dont le format vidéo est incorrect. Assurez-vous que votre 
moniteur est compatible avec la carte graphique et que vous avez installé le bon 
pilote (si le moniteur a été livré avec un logiciel d’installation). 
• Si vous voyez une séquence répétée de deux flashs courts et un flash long, le moniteur 
détecte un problème de lampe de rétro-éclairage. Contactez un revendeur ou un 
centre de maintenance agréé Apple. 
Utilisation de Apple Hardware Test
Apple Hardware Test vous aide à déterminer s’il existe un problème matériel 
sur votre ordinateur. 
Pour utiliser Apple Hardware Test :
1 Déconnectez tous les périphériques de votre ordinateur sauf le clavier et la souris. 
Si un câble Ethernet est connecté, déconnectez-le.
2 Insérez le disque “Logiciels supplémentaires et Apple Hardware Test” fourni avec votre 
ordinateur. 
3 Puis redémarrez votre ordinateur en maintenant la touche C enfoncée lors du 
démarrage. Une liste de volumes de démarrage disponibles apparaît alors. Cliquez 
sur Apple Hardware Test, puis sur la flèche droite.
4 Lorsque l’écran principal Apple Hardware Test apparaît environ 45 secondes plus tard, 
suivez les instructions affichées à l’écran.
5 En cas de détection d’un problème, Apple Hardware Test affiche un code d’erreur. 
Notez le code d’erreur avant d’entreprendre les démarches d’assistance. Si Apple 
Hardware Test ne détecte pas de panne de matériel, il est probable que le problème 
soit lié aux logiciels.78 Chapitre 4 Dépannage
Pour en savoir plus sur Apple Hardware Test, consultez le fichier Ouvrez-moi À propos de 
Apple Hardware Test sur le disque “Logiciels supplémentaires et Apple Hardware Test”.
Installation de logiciels sur votre ordinateur
Les disques d’installation de logiciels fournis avec votre ordinateur permettent 
d’installer Mac OS X, les applications livrées avec votre ordinateur et Classic Support.
Important : Apple vous recommande de sauvegarder les données de votre disque dur 
avant de procéder à la restauration du logiciel. Apple décline toute responsabilité en 
cas de perte de données.
Installation de Mac OS X et des applications
Pour installer Mac OS X et les applications fournies avec votre ordinateur, veuillez 
procéder comme suit :
1 Sauvegardez vos fichiers essentiels si cela est possible.
2 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur.
3 Double-cliquez sur “Install Mac OS X and Bundled Software”.
4 Suivez les instructions à l’écran.
5 Après avoir sélectionné le disque de destination pour l’installation, suivez les 
instructions à l’écran. Il se peut que votre ordinateur redémarre et vous demande 
d’insérer le disque 2 d’installation de Mac OS X.
Remarque : si vous souhaitez rétablir les réglages d’origine du logiciel sur votre 
ordinateur, cliquez sur Options dans la sous-fenêtre “Sélectionner une destination” 
du programme d’installation, puis choisissez “Effacer et installer”. 
Important : nous vous conseillons de sauvegarder vos fichiers essentiels avant 
d’installer Mac OS X et les autres applications car l’option “Effacer et installer” efface 
votre disque de destination.Chapitre 4 Dépannage 79
Installation des applications
Pour installer uniquement les applications fournies avec votre ordinateur, veuilles 
procéder comme suit. Mac OS X doit déjà être installé sur votre ordinateur. 
1 Sauvegardez vos fichiers essentiels si cela est possible.
2 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur.
3 Double-cliquez sur “Install Bundled Software Only.”
4 Suivez les instructions à l’écran.
5 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran. Il se peut que votre ordinateur redémarre et vous demande d’insérer le disque 
2 d’installation de Mac OS X.
Remarque : pour installer iCal, iChat AV, iMovie, iPhoto, iSync, iTunes et Safari, suivez 
les instructions du paragraphe “Installation de Mac OS X et des applications” ci-dessus.
Installation de la gestion de Classic et d’autres applications
Utilisez le disque “Logiciels supplémentaires et Apple Hardware Test” pour installer la 
gestion de Classic ainsi que d’autres applications qui ne sont pas incluses sur le disque 1 
d’installation de Mac OS X. Installez la gestion de Classic si vous souhaitez utiliser des 
applications de Mac OS 9 avec votre ordinateur.
Procédez comme suit pour installer la gestion de Classic ou d’applications 
supplémentaires : 
1 Sauvegardez vos fichiers essentiels si cela est possible.
2 Insérez le disque “Logiciels supplémentaires et Apple Hardware Test” fourni avec votre 
ordinateur.
3 Double-cliquez sur “Installer les logiciels complémentaires Test”.
4 Suivez les instructions à l’écran.
5 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran pour une installation standard, ou cliquez sur “Personnaliser” pour choisir les 
applications que vous désirez installer. 80 Chapitre 4 Dépannage
Optimisation des performances Ethernet
Votre ordinateur fonctionne de façon optimale lorsque le port Ethernet auquel il est 
connecté est réglé sur la négociation automatique. Demandez à votre administrateur 
de réseau de vérifier ce réglage. 
Important : si vous rencontrez des problèmes de connexion sur votre réseau, vérifiez, 
si possible, que le commutateur de réseau est réglé sur la négociation automatique. 
Si le port du commutateur ne fonctionne pas en négociation automatique, votre 
ordinateur détectera la vitesse appropriée, mais se réglera par défaut sur le mode semiduplex. Si le port du commutateur à l’autre extrémité de la liaison est configuré en 
mode bidirectionnel simultané (full duplex), un grand nombre d’événements retardés 
peuvent se produire sur la liaison. S’il n’est pas possible de régler le commutateur sur
la négociation automatique, réglez alors le port du commutateur sur semi-duplex. 
Pour plus d’informations, reportez-vous à la documentation fournie avec le 
commutateur Ethernet.
Remarque : si vous connectez votre ordinateur directement à un commutateur 
Ethernet configurable, demandez à votre administrateur de réseau de désactiver 
l’arborescence sur ce port. Dans le cas contraire, il se peut que votre ordinateur 
duplique l’adresse AppleTalk d’un autre ordinateur du même réseau, ce qui rendrait 
instables les deux connexions au réseau.
Localisation du numéro de série de votre produit
Le numéro de série de votre Power Mac G5 se trouve sur l’étiquette de configuration, 
à l’intérieur du panneau latéral, directement sous le déflecteur d’air. Vous le trouverez 
également dans les Informations Système. Ouvrez les Informations Système (dans 
Applications/Utilitaires) et cliquez sur l’onglet Informations Système.81
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Caractéristiques techniques du processeur et de la mémoire 
Processeur
• Processeur PowerPC avec 512 Ko de mémoire cache sur puce L2 par processeur
Mémoire vive (RAM)
• Mémoire dynamique synchrone (SDRAM) à double vitesse de transfert (DDR)
• Toute la mémoire SDRAM DDR est fournie sous forme de modules DIMM 
(Dual Inline Memory Modules)
• Modules DIMM installés par paires de capacité égale
• Quatre ou huit logements DIMM sont disponibles pour la mémoire PC 3200 
SDRAM DDR à 400 MHz, en fonction du modèle de votre ordinateur
Les modules DIMM de 256 Mo doivent être conformes à la technologie 128 ou 
256 mégabits (Mbits), les modules DIMM de 512 Mo à la technologie 256 Mbits 
et les modules DIMM de 1 Go à la technologie 512 Mbits.
• 2,5 volts (V) sans tampon
• 184 broches
• Sans code de correction d’erreurs
• Sans parité
Les Informations Système, dans le répertoire Applications/Utilitaires, fournissent 
des informations sur votre ordinateur et notamment sur la quantité de mémoire.
Contrôleur graphique
• Carte graphique AGP 8X Pro munie d’un connecteur ADC (Apple Display Connector) 
et d’un connecteur DVI (Digital Visual Interface). Compatible AGP 3.0 ou AGP Pro.
Modes d’affichage vidéo
Pour les caractéristiques techniques de votre moniteur :
• Moniteurs Apple : rendez-vous sur le site Internet Apple et vérifiez les caractéristiques 
de votre produit sur www.apple.com/displays.
• Moniteurs de tierce partie : rendez-vous sur www.apple.com/guide.82 Annexe A Caractéristiques
Caractéristiques techniques de l’unité Combo (DVD-ROM/CD-RW)
• Diamètres de disque gérés : 12 cm et 8 cm 
Formats de données
• CD-ROM
• CD Audio
• CD-R
• CD-RW
• CD-I
• CD-I Bridge
• CD Extended (CD étendu)
• CD Mixed Mode (CD en mode mixte)
• CD Photo
• CD Vidéo
• CD Extra
• DVD vidéo
• DVD-ROM
• DVD-R (lecture seule)
Caractéristiques techniques de l’unité SuperDrive (DVD-R/CD-RW)
• Diamètres de disque gérés : 12 cm et 8 cm 
Formats de données
• CD-ROM
• CD Audio
• CD-R
• CD-RW
• CD-I
• CD-I Bridge
• CD Extended (CD étendu)
• CD Mixed Mode (CD en mode mixte)
• CD Photo
• CD Vidéo
• CD Extra
• DVD vidéo
• DVD-ROM
• DVD-R Annexe A Caractéristiques 83
Caractéristiques techniques des ports USB 
• Gestion d’Universal Serial Bus (USB) 2.0 et 1.1
• Cinq ports USB externes Type A
• Un port USB 2.0 en façade 
• Deux ports USB 2.0 à l’arrière
• Deux ports USB 1.1 intégrés au clavier Apple
• Chaque port arrière se trouve sur un canal USB distinct de 480 mégabits par seconde 
(Mbps).
• Intensité disponible pour chaque port USB de 500 milliampères (mA) à 5 V, pour un 
total de 1,5 ampère
Caractéristiques techniques de FireWire 
• Gestion de FireWire 400 et FireWire 800
• Trois ports FireWire externes
• Un port FireWire 400 en façade
• Un port FireWire 400 et un port FireWire 800 à l’arrière
• Vitesse de transfert de données :
• FireWire 400 : 100, 200 et 400 Mbps
• FireWire 800 : 100, 200, 400 et 800 Mbps
Puissance
• Plage de tension de sortie : environ 13 à 25 V
• Plage de puissance de sortie : jusqu’à 15 W
Caractéristiques techniques du réseau Ethernet 
• Conforme à la directive IEEE 802.3
• Longueur maximale du câble : 100 mètres (m)
• Protocoles : Open Transport, AppleShare, AppleTalk, NetWare pour Macintosh, TCP/IP
• Connecteur : RJ-45 pour 10Base-T, 100Base-TX et 1000Base-T
• Support, 10Base-T : câble UTP de catégorie 3 ou supérieure sur 2 paires jusqu’à 100 m
• Support, 100Base-TX : câble UTP de catégorie 5 sur 2 paires jusqu’à 100 m
• Support, 1000Base-T : câble UTP de catégorie 5 et 6 sur 4 paires jusqu’à 100 m
• Vitesses de canal : auto-négociation IEEE de 10Base-T, 100Base-TX et 1000Base-T
Caractéristiques techniques du modem
• Norme de transmission de données : K56Flex et V.92
• Vitesse : 53 kilobits par seconde (Kbps)
• Norme de télécopie : ITU V.17
Caractéristiques Bluetooth (facultatif)
• Vitesse de transfert de données sans fil : jusqu’à 1 Mbps
• Portée : jusqu’à 10 mètres (le débit de transmission de données peut varier 
en fonction des conditions ambiantes)
• Bande de fréquences : 2,4 gigahertz (GHz)84 Annexe A Caractéristiques
Caractéristiques AirPort Extreme Card (facultatif)
• Vitesse de transfert de données sans fil : jusqu’à 54 Mbps
• Portée : jusqu’à 45,72 mètres (le débit de transmission de données peut varier 
en fonction des conditions ambiantes)
• Bande de fréquences : 2,4 gigahertz (GHz)
• Puissance de sortie radio : 15 dBm (nominal)
Compatibilité
• Norme 802.11 DSSS (Direct Sequence Spread Spectrum) 1 et 2 Mbps
• standard 802.11b 11 Mbps
• standard 802.11b 54 Mbps
Caractéristiques Audio numérique optique 
• Format de données : Protocole Sony/Phillips Digital Interface (S/PDIF) (IEC60958-3)
• Type de connecteur : Optique Toslink (IEC60874-17)
• Bits par échantillon : 16 bits ou 24 bits
Sortie audio numérique optique 
Basé sur situation typique, avec lecture d’une onde sinusoïdale 1 kHz, -1 dBFS 24 bits, 
fréquence d’échantillonnage en sortie de 44,1 kHz, sauf indications contraires cidessous.
• Fréquence d’échantillonnage en sortie : 32 kHz, 44,1 kHz ou 48 kHz
• Rapport signal-bruit : Supérieur à 130 dB
• Total distorsion harmonique + bruit : Inférieur à -130 dB (0,00001 pour cent)
Entrée audio numérique optique 
Basé sur situation typique, avec lecture d’une onde sinusoïdale 1 kHz, -1 dBFS 24 bits, 
sauf indications contraires ci-dessous.
• Fsi–fréquence d’échantillonnage d’entrée (mode horloge externe) : 32 kHz, 44,1 kHz 
ou 48 kHz
• Fsi–fréquence d’échantillonnage d’entrée (mode horloge interne) : 16 kHz à 96 kHz
• Rapport signal sur bruit (mode horloge externe) : Supérieur à 130 dB
• Rapport signal sur bruit (mode horloge interne, 16 kHz < Fsi < 96 kHz) : Inférieur 
à -112 dB
• Total distorsion harmonique + bruit (mode horloge externe) : Inférieur à -130 dB 
(0,00001 %)
• Total distorsion harmonique + bruit (mode horloge interne, 16 kHz < Fsi < 96 kHz) : 
Inférieur à -112 dB (0,0003 %)Annexe A Caractéristiques 85
Caractéristiques audio analogique
• Fréquence d’échantillonnage : 32 kHz, 44,1 kHz ou 48 kHz
• Type de jack : Mini-jack 3,5 mm
• Bits par échantillon : 16 bits ou 24 bits
• Réponse en fréquence : 20 Hz à -20 kHz, +0,5 dB/-3 dB 
Sortie audio via la prise d’écouteurs
• Tension de sortie : 1,4 volts (valeur efficace) (Vrms) (+4 dbu)
• Impédance de sortie : 24 ohms
• Puissance de sortie : 20 milliwatts (mW)
• Rapport signal-bruit : supérieur à 90 dB
• Distorsion harmonique totale : inférieure à -80 dB (0,01 pour cent)
• Séparation des voies : supérieure à 65 dB
Entrée audio analogique
• Tension d’entrée maximale : 2 volts (valeur efficace) (Vrms) (+8 dbu)
• Impédance d’entrée : supérieure à 47 kilohms
• Rapport signal-bruit : supérieur à 90 dB
• Distorsion harmonique totale : inférieure à -85 dB (0,006 percent)
• Séparation des voies : supérieure à 75 dB
Sortie audio analogique 
• Tension de sortie : 1,4 volts (valeur efficace) (Vrms) (+4 dbu)
• Impédance de sortie : 24 ohms
• Rapport signal-bruit : supérieur à 90 dB
• Distorsion harmonique totale : inférieure à -80 dB (0,01 pour cent)
• Séparation des voies : supérieure à 65 dB
Alimentation 
Entrée de ligne CA
• Gamme de tensions : Courant alternatif (AC) de 100 à 240 V
• Intensité : 7,5 ampères (A) monoprocesseur ou 9,5 ampères (A) double processeur
• Fréquence : 50-60 Hz
Sortie du moniteur DC
• 4,0 A maximum pour un courant continu (CC) de tension nominale 25 V provenant 
du connecteur ADC (Apple Display Connector)86 Annexe A Caractéristiques
Alimentation requise pour les périphériques que vous pouvez 
connecter
Cartes d’extension
• La quantité maximale et totale d’énergie consommée par les cartes AGP et PCI 
est de 90 W.
Périphériques USB
• Chacun des ports USB intégrés dispose de 500 mA. 
Périphériques FireWire
• L’ordinateur peut fournir un total de 15 W aux ports FireWire.
Horloge et pile du système 
• Circuit CMOS personnalisé avec pile longue durée au lithium. Vous pourrez remplacer 
la pile de l’ordinateur (voir “Remplacement de la pile” à la page 70) par une nouvelle 
pile que vous pouvez acheter auprès d’un distributeur agréé Apple.
Dimensions et conditions de fonctionnement
Dimensions
• Poids : 17,84 kg (39.32 lb)
Le poids dépend du modèle. Le poids indiqué ci-dessus correspond au modèle 
de base : monoprocesseur, un lecteur optique et un disque dur. Le poids peut être 
plus élevé si des périphériques optionnels sont installés.
• Hauteur : 511 mm (20,12 pouces)
• Largeur : 206 mm (8,11 pouces)
• Profondeur : 475 mm (18,70 pouces)
Conditions de fonctionnement
• Température de fonctionnement : 10 °C à 35 °C (50 °F à 95 °F)
• Température de stockage : 40 °C à 47 °C (40 °F à 116 °F)
• Humidité relative : 5 % à 95 % (sans condensation)
• Altitude : 0 à 3 048 mètres (0 à 10,000 pieds)87
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B Environnement de travail, sécurité 
et entretien
Cette annexe contient des informations importantes 
concernant les consignes de sécurité et l'entretien 
ainsi que des remarques sur l'organisation de l'espace 
de travail pour l'utilisation de votre ordinateur et 
de votre moniteur.
Consignes de sécurité importantes
Le seul moyen de couper totalement l'alimentation de votre ordinateur consiste 
à débrancher le câble d'alimentation de la source d'alimentation principale. Pour 
déconnecter complètement votre moniteur, vous devez également débrancher le câble 
d'alimentation qui le raccorde à l'ordinateur ou à la source d'alimentation. Assurez-vous 
qu'au moins une des extrémités du câble d'alimentation du périphérique peut être 
atteinte facilement de manière à pouvoir débrancher l'ordinateur ou le moniteur 
quand cela est nécessaire.
Pour votre propre sécurité et celle de votre matériel, respectez toujours les 
consignes suivantes.
Si l'un des cas suivants se présente, débranchez la fiche d'alimentation (en tirant sur 
la fiche et non sur le câble) de l'ordinateur ou du moniteur et débranchez le câble 
du téléphone :
• Le câble ou la fiche d'alimentation est usé(e) ou endommagé(e).
• Vous avez renversé quelque chose dans le boîtier de l'ordinateur.
• L'ordinateur ou le moniteur a été exposé à la pluie ou à tout autre type d'humidité 
excessive.
• L'ordinateur ou le moniteur est tombé ou son boîtier a été endommagé.
• Vous pensez que l’ordinateur ou le moniteur doit faire l’objet d’une révision ou 
d’une réparation.
• Vous voulez nettoyer l’écran ou le boîtier de l’ordinateur ou du moniteur. 
• Vous remarquez une fuite du liquide de refroidissement à l’intérieur ou à l’extérieur 
de votre ordinateur (pour les modèles de Power Mac G5 équipés d’un système de 
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Si vous avez l’intention de ranger votre ordinateur pour une période prolongée, retirez 
la batterie.
Pour prévenir les accidents et éviter d’endommager votre ordinateur ou votre 
moniteur, veillez à toujours observer les consignes suivantes :
• Maintenez votre ordinateur éloigné de toute source de liquide et d’humidité.
• Ne placez aucun objet sur le dessus de l’ordinateur ou du moniteur.
• Veillez à ce que les grilles d’aération de l’ordinateur et du moniteur ne soient 
pas obstruées.
• N’enlevez jamais le boîtier du moniteur et n’ouvrez pas l’ordinateur quand il est 
allumé. Vous risquez de recevoir une décharge électrique.
• Lorsque le temps est orageux, déconnectez votre modem de la prise téléphonique 
afin d’éviter qu’une surcharge de tension n’endommage ce dernier.
Déplacez avec soin votre ordinateur et votre moniteur. Pour soulever l’appareil, veillez 
à suivre la procédure recommandée qui consiste à fléchir les jambes. Quand vous 
transportez le moniteur, assurez-vous que vous faites face à l’écran. Ne le transportez 
pas en le saisissant par le socle.
Système de refroidissement liquide
Certains modèles de Power Mac G5 utilisent un système de refroidissement liquide 
pour contrôler la température à l’intérieur de l’ordinateur. Le système de refroidissement 
liquide est scellé et conçu pour être ouvert uniquement par un fournisseur de services 
agréé Apple (Apple Authorized Service Provider ou AASP).
Avertissement : votre Macintosh est équipé d’une prise de mise à la terre à trois fils, 
c’est-à-dire une prise munie d’une troisième broche reliée à la terre. Il s’agit d’une 
mesure de sécurité. Ne modifiez pas la fiche pour pouvoir l’insérer dans une prise 
non reliée à la terre. Faites appel à un électricien agréé pour installer une prise 
correctement reliée à la terre. Ne dérogez en aucun cas à cette consigne.
Avertissement : le matériel électrique peut s’avérer dangereux s’il n’est pas utilisé 
correctement. L’utilisation de ce produit par un enfant doit toujours être supervisée 
par un adulte. Ne permettez pas aux enfants de toucher les composants internes 
de tout appareil électrique, ni de manipuler des câbles électriques.
Avertissement : n’essayez pas d’ouvrir ou de réparer le système de refroidissement 
liquide. L’ouverture du système de refroidissement liquide peut endommager votre 
matériel, et de tels dommages ne sont pas forcément couverts par la garantie limitée 
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Pour des réparations ou des questions liées à votre garantie, contactez un fournisseur de 
services agréé Apple (Apple Authorized Service Provider) ou Apple. La documentation 
fournie avec votre ordinateur contient des informations relatives à l’assistance et 
à la maintenance.
Apple et l’environnement
Apple reconnaît sa responsabilité en matière de minimisation de l’impact de ses 
opérations et de ses produits sur l’environnement. 
Pour plus d’informations
Rendez-vous sur le site Web www.apple.com/about/environment.
Avertissement : utilisez toujours votre ordinateur en position verticale. Au cas 
improbable où le liquide fuirait à l’intérieur ou à l’extérieur de votre ordinateur, 
déconnectez toute alimentation électrique de votre ordinateur et ne le redémarrez 
pas. Contactez un fournisseur de services agréé Apple (Apple Authorized Service 
Provider) ou contactez Apple pour obtenir des informations sur la réparation de 
votre ordinateur. 
Après avoir déconnecté l’alimentation électrique, vous pouvez nettoyer le liquide 
de refroidissement avec un tissu absorbant. Évitez toute inhalation ou tout contact 
direct avec la peau : le liquide peut entraîner une légère irritation de la peau. En cas 
de contact avec la peau, laver abondamment au savon et à l’eau. En cas de contact 
avec les yeux, rincer abondamment à l’eau. Les matériaux ayant servi au nettoyage 
doivent être recyclés ou traités conformément aux lois, normes et directives locales. 
Le liquide de refroidissement peut être nocif s’il est avalé. Des fiches toxicologiques 
(Material Safety Data Sheets ou MSDS) sont disponibles sur le site 
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Entretien général
Pour nettoyer votre ordinateur ou le moniteur de manière plus complète, procédez 
comme suit :
1 Éteignez l’ordinateur et le moniteur.
2 Déconnectez le câble d’alimentation de l’ordinateur au niveau de la prise ou multiprise 
électrique. Si votre moniteur est branché sur une prise, débranchez-le également.
3 Débranchez les câbles du moniteur au niveau de l’ordinateur.
4 Nettoyez l’écran du moniteur à l’aide d’un papier absorbant ou d’un tissu doux et 
non pelucheux imbibé d’eau légèrement savonneuse. 
5 Nettoyez délicatement le boîtier de l’ordinateur ou du moniteur à l’aide d’un chiffon 
propre, doux et humide.
Important : n’utilisez pas d’alcool, d’aérosols ni de produits solvants ou abrasifs 
susceptibles d’endommager la finition du boîtier.
Protection de votre lecteur optique
Pour garantir le bon fonctionnement de votre lecteur optique :
• Placez votre ordinateur de sorte que le plateau du lecteur ne heurte aucun obstacle 
lors de son ouverture.
• Laissez le lecteur fermé lorsque vous ne l’utilisez pas.
• Ne placez aucun objet sur le plateau du lecteur lorsqu’il est ouvert.
• Ne touchez pas la lentille du lecteur optique avec vos doigts. N’essuyez pas la lentille 
du lecteur avec un mouchoir en papier ni aucune autre matière abrasive. Si vous 
devez la nettoyer, procurez-vous les produits adéquats auprès d’un fournisseur de 
services agréé Apple.
• Maintenez votre ordinateur éloigné de toute source d’humidité.
Entretien de votre moniteur
Pour entretenir votre moniteur et en garantir la longévité :
• N’appuyez pas sur la surface de l’écran.
• N’écrivez pas sur l’écran et ne le touchez pas avec un objet tranchant.
• Si vous comptez ne pas utiliser le moniteur ni l’ordinateur pendant au moins 
une journée, éteignez-les ou utilisez les réglages Économiseur d’énergie.
• En cas d’inactivité prolongée de votre ordinateur, éteignez l’écran, baissez la 
luminosité ou utilisez un programme d’économie d’écran qui assombrit ou 
modifie l’image affichée. 
Avertissement : ne vaporisez pas de liquide directement sur l’écran du moniteur. Une 
partie de ce liquide pourrait s’infiltrer à l’intérieur et provoquer une décharge électrique.Annexe B Environnement de travail, sécurité et entretien 91
Informations importantes sur l’organisation de l’espace 
de travail et la santé
Voici quelques conseils permettant d’adapter votre environnement de travail à votre 
morphologie et prévenir la fatigue oculaire.
• Optez pour un siège de bureau réglable et offrant un dossier et une assise 
confortables. Réglez la hauteur du siège de manière à ce que vos cuisses soient 
légèrement inclinées et que vos pieds soient posés à plat sur le sol. 
Le dossier du siège doit soutenir votre région lombaire, c’est-à-dire la partie 
inférieure de votre dos. Suivez les instructions du fabricant de sorte que le réglage 
du dossier soit parfaitement adapté à votre morphologie.
• Lorsque vous utilisez le clavier de l’ordinateur, vos épaules doivent être détendues. 
Le bras et l’avant-bras doivent former un angle droit, ou presque, et votre main doit 
être dans le prolongement du poignet. 
Au besoin, relevez le siège de manière à ce que vos avant-bras et vos mains soient 
placés correctement par rapport au clavier. Si, dans ce cas, vos pieds ne reposent 
plus à plat sur le sol, utilisez un repose-pied inclinable et réglable en hauteur. Si vous 
disposez d’un bureau modulaire, vous pouvez abaisser le niveau du plan de travail 
pour éviter l’emploi d’un repose-pied. Une troisième solution consiste à utiliser un 
bureau dont le poste de saisie est situé plus bas que le plan de travail.
• Veillez à ce que la souris se trouve à hauteur du clavier. Prévoyez également un 
espace suffisant pour pouvoir la manipuler commodément.
• Placez le moniteur de manière à ce que le haut de l’écran soit légèrement en dessous 
du niveau de vos yeux quand vous êtes assis au clavier. Il vous appartient de juger 
de la meilleure distance entre vos yeux et l’écran. Elle se situe en général entre 45 
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• Positionnez le moniteur de façon à éviter d’être ébloui par la réflexion sur ce dernier 
de l’éclairage au plafond ou de la lumière des fenêtres de la pièce. Si possible, utilisez 
un pied de moniteur inclinable. Le pied vous permet de régler le meilleur angle de 
vision et de réduire ou d’éliminer l’éblouissement causé par les sources lumineuses 
impossibles à déplacer.
Pour plus d’information sur l’hygiène, la sécurité et la maintenance, consultez la page 
Internet d’Apple sur l’ergonomie à l’adresse www.apple.com/about/ergonomics.
Cuisses légèrement inclinées
Épaules détendues
Écran orienté de manière 
à réduire les reflets
Mains dans le 
prolongement 
des avant-bras
Avant-bras à l’horizontale 
ou légèrement relevés
Dossier soutenant 
la région lombaire
Pieds à plat sur le sol
ou sur un repose-pied
Haut de l’écran au niveau 
des yeux ou légèrement 
en dessous. (Vous devrez 
peut-être ajuster la hauteur 
du moniteur en surélevant 
votre plan de travail ou le 
moniteur lui-même.)
Espace dégagé sous 
le plan de travail
45–70 cm 93
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C Connexion à Internet
Votre ordinateur vous permet de naviguer sur le Web, 
d’échanger du courrier électronique avec vos amis et 
votre famille ou de dialoguer en temps réel via Internet. 
Suivez les instructions de ce guide détaillé pour vous 
connecter à Internet.
Pour utiliser Internet, vous avez besoin d’un compte auprès d’un FAI. L’Assistant 
réglages peut en configurer un pour vous. Dans certains pays, l’Assistant réglages 
ne peut pas vous configurer un compte auprès d’un FAI. Vous devez donc contacter 
un FAI pour obtenir un compte. Utilisez ensuite les informations contenues dans cette 
annexe pour configurer votre connexion
Si vous n’avez pas utilisé l’Assistant réglages pour configurer votre connexion à 
Internet, vous pouvez l’utiliser maintenant. Ouvrez Préférences Système, puis cliquez 
sur Réseau. Cliquez sur le bouton “Assistez-moi” pour ouvrir l’Assistant réglages de 
réseau. Si vous ne souhaitez pas utiliser cet Assistant, vous pouvez réaliser votre 
connexion manuellement à l’aide des informations données dans cet annexe.
Il existe quatre types de connexion à Internet :
• Connexion par ligne téléphonique : l’ordinateur est relié à une prise téléphonique 
murale via un câble téléphonique (pour les ordinateurs comprenant un modem).
• Connexion via un modem câble ou DSL à haut débit : l’ordinateur est relié via 
un câble Ethernet à un modem spécial fourni par un FAI.
• Connexion sans fil AirPort Extreme : votre ordinateur est connecté sans fil 
à Internet via une borne d’accès AirPort Extreme.
• Réseau local (LAN) : l’ordinateur est connecté à un réseau local via un câble 
Ethernet. C’est le type de connexion habituellement utilisé dans les entreprises.94 Annexe C Connexion à Internet
Avant de vous connecter à Internet :
1 Procurez-vous les informations de connexion auprès de votre FAI ou de votre 
administrateur réseau. Consultez la section suivante, “Collecte des informations 
nécessaires”, pour savoir quelles sont les informations dont vous avez besoin pour 
chaque type de connexion. 
Si un autre ordinateur se trouvant au même emplacement est déjà connecté à Internet, 
vous pouvez probablement utiliser ses réglages. 
Pour accéder aux réglages sur un ordinateur Mac OS X :
• Ouvrez la fenêtre Réseau des Préférences Système.
• Dans le menu local Afficher, sélectionnez votre mode de connexion. 
• Copiez les informations concernant votre connexion.
Pour accéder aux réglages sur un ordinateur Mac OS 9 :
• Ouvrez le tableau de bord TCP/IP.
• Rechercher le mode de connexion dans le menu local “Connexion”.
• Recherchez la configuration dans le menu local Configurer.
• Notez l’adresse IP, le masque de sous-réseau et l’adresse du routeur figurant 
dans les champs correspondants.
Pour accéder aux réglages sur un PC Windows :
Les informations de connexion d’un PC Windows se trouvent à deux endroits.
• Pour trouver l’adresse IP et le masque de sous-réseau, ouvrez le tableau de bord 
“Connexions réseau et Internet”.
• Pour accéder aux informations relatives aux comptes d’utilisateurs, ouvrez le tableau 
de bord Comptes d’utilisateurs. 
Vous pouvez écrire ces informations directement sur les pages suivantes, puis les saisir 
dans l’Assistant réglages.
2 Si vous utilisez un modem téléphonique, branchez un câble téléphonique (inclus avec 
la plupart des ordinateurs Macintosh) sur le port modem de votre ordinateur et sur une 
prise téléphonique murale. Si vous disposez d’un modem DSL ou câble, connectez-le 
à votre ordinateur en suivant les instructions incluses.Annexe C Connexion à Internet 95
Collecte des informations nécessaires
Vous pouvez noter sur ces pages les informations obtenues auprès de votre Fournisseur 
d’Accès à Internet (FAI), de votre administrateur réseau ou de votre autre ordinateur, 
puis les saisir dans l’Assistant réglages de réseau.
Pour configurer une connexion téléphonique classique, procurez-vous 
les informations suivantes :
• Nom du fournisseur d’accès
• Nom d’utilisateur ou de compte
• Mot de passe
• Numéro de téléphone du FAI
• Numéro de téléphone de remplacement
• Préfixe pour obtenir une ligne extérieure
Pour configurer une connexion DSL, modem câble, LAN ou sans fil 
AirPort Extreme :
m
Choisissez d’abord votre méthode de connexion (en cas de doute, consultez votre 
administrateur système ou votre FAI) :
• Manuellement
• Utilisation de DHCP avec une adresse manuelle
• Via DHCP
• Via BootP
• PPP
Si vous ne savez pas quelle méthode utiliser, il est recommandé d’activer l’option 
“Via DHCP”, car le réseau fournit alors la plupart des informations requises 
automatiquement.
Si vous avez sélectionné “Manuellement” ou “Utilisation de DHCP avec une adresse 
manuelle” procurez-vous les informations suivantes :
• Adresse IP
• Masque de sous-réseau
• Adresse du routeur
Remarque : si vous avez sélectionné “Utilisation de DHCP avec une adresse manuelle”, 
vous n’avez pas besoin d’un masque de sous-réseau ni d’adresse de routeur.96 Annexe C Connexion à Internet
Si vous avez sélectionné “Via DHCP”, procurez-vous les informations suivantes 
facultatives (le cas échéant, consultez votre FAI) :
• ID client DHCP
• serveurs DNS
Si vous avez sélectionné “PPP” (pour des connexions PPPoE), procurez-vous les 
informations suivantes :
• Fournisseur d’accès
• Nom du compte
• Mot de passe
• Nom du service PPPoE
Les informations ci-dessous sont facultatives. Consultez votre FAI ou votre 
administrateur système si nécessaire.
• serveurs DNS
• Nom de domaine
• Serveur proxy
Saisie de vos informations
Après vous être procuré les informations de configuration spécifiques auprès de votre 
FAI ou de votre administrateur réseau, vous pouvez soit cliquer sur le bouton “Assistezmoi” dans la fenêtre des préférences Réseau pour ouvrir l’Assistant réglages de réseau, 
soit saisir les informations manuellement. 
Pour saisir vos informations manuellement, suivez les étapes correspondant à votre 
mode de connexion.
• Modem téléphonique avec connexion PPP (Point-to-Point Protocol) (voir la page 97)
• Connexion via modem câble, DSL ou réseau LAN (la page 100) avec les 
configurations suivantes :
• Manuelle
• DHCP
• PPPoE
• Connexion sans fil AirPort Extreme (voir la page 105)Annexe C Connexion à Internet 97
Modem téléphonique avec connexions PPP (Point-To-Point 
Protocol)
Le modem téléphonique constitue la manière la plus courante de se connecter 
à Internet. Votre modem utilise une méthode appelée PPP (Point-to-Point Protocol) 
pour se connecter à un FAI.
Assurez-vous que votre modem est branché sur une ligne téléphonique et que vous 
disposez des informations fournies par votre FAI (voir la page 95).
Pour configurer l’utilisation du port de modem interne dans les préférences 
Réseau : 
1 Dans la barre des menus, sélectionnez le menu Pomme (K) > Préférences Système. 
2 Cliquez sur Réseau.
3 Choisissez Configuration des ports réseau dans le menu local Afficher, puis cochez la 
case Activé à côté de Modem interne.
4 Faites glisser Modem interne en haut de la liste Configurations de port pour en faire 
l’interface réseau préférée ou principale.
5 Choisissez Modem interne dans le menu local Afficher et cliquez sur PPP. 98 Annexe C Connexion à Internet
6 Saisissez les informations fournies par votre FAI, puis cliquez sur Appliquer. 
Pour tester votre configuration Internet :
1 Ouvrez l’application Connexion à Internet (dans le dossier Applications).
2 Cliquez sur l’icône Modem interne si nécessaire.
3 Tapez le numéro de téléphone de connexion de votre FAI, votre nom de compte 
et votre mot de passe, si nécessaire.
4 Cliquez sur Se connecter.
L’application Connexion à Internet compose le numéro de votre FAI et établit 
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Pour vous connecter automatiquement dès que vous ouvrez une application 
TCP/IP, telle qu’un navigateur Web ou une messagerie électronique, procédez 
de la manière suivante :
1 Cliquez sur Options PPP (dans la fenêtre PPP des préférences Réseau).
2 Cochez la case “Se connecter automatiquement si nécessaire”.
3 Cliquez sur OK, puis sur Appliquer. 
Connexions à Internet par ligne DSL, modem câble ou 
réseau LAN
Si vous vous connectez à Internet soit à l’aide d’un modem DSL ou câble, soit via un 
réseau LAN Ethernet, demandez à votre FAI ou à votre administrateur réseau comment 
vous devriez configurer votre connexion à Internet :
• Manuellement : dans le cas d’une configuration manuelle, votre FAI ou administrateur 
réseau vous indique une adresse IP statique et d’autres informations que vous devez 
saisir dans les préférences Réseau.
• Via le protocole DHCP (Dynamic Host Configuration Protocol). avec une configuration 
DHCP, le serveur DHCP saisit automatiquement les informations à votre place.
• Via le protocole PPPoE (Point-to-Point Protocol over Ethernet). si vous utilisez un 
modem DSL et que vous avez besoin d’un nom d’utilisateur et d’un mot de passe 
pour vous connecter à Internet, vous devrez éventuellement configurer votre réseau 
pour qu’il utilise le protocole PPPoE.
Lors de la configuration de votre réseau, veillez à garder les informations fournies 
par votre FAI à portée de main (voir la page 95).100 Annexe C Connexion à Internet
Pour configurer les Préférences réseau pour le port Ethernet intégré :
1 Dans la barre des menus, sélectionnez le menu Pomme (K) > Préférences Système.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez Configurations de ports réseau.
4 Sélectionnez Ethernet intégré.
5 Faites glisser Ethernet intégré en haut de la liste Configurations de port pour en faire 
l’interface réseau préférée ou principale. 
Suivez ensuite les instructions de configuration manuelle de votre réseau, via DHCP 
ou PPPoE, selon les recommandations de votre FAI ou de votre administrateur réseau.Annexe C Connexion à Internet 101
Configuration manuelle
Ayez à portée de main votre adresse IP statique, l’adresse du routeur et le masque 
de sous-réseau fournis par votre FAI (voir la page 95).
Pour effectuer une configuration manuelle : 
1 Dans préférence Réseau, sélectionnez Ethernet intégré dans le menu local Afficher.
2 Cliquez sur TCP/IP, si nécessaire.
3 Dans le menu local Configurer IPv4, choisissez Manuellement.
4 Remplissez le reste des champs. 
5 Cliquez sur Appliquer.
Votre connexion est prête dès que vous avez configuré votre réseau. Ouvrez votre 
navigateur Web (ou une autre application TCP/IP) afin de tester votre connexion 
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Configuration DHCP
Après avoir choisi une configuration DHCP, le serveur DHCP fournit automatiquement 
vos informations de réseau.
Pour configurer DHCP :
1 Dans préférence Réseau, sélectionnez Ethernet intégré dans le menu local Afficher.
2 Cliquez sur TCP/IP, si nécessaire.
3 Choisissez Via DHCP dans le menu local Configurer IPv4.
4 Cliquez sur Appliquer.
Ouvrez votre navigateur Web (ou une autre application TCP/IP) afin de tester votre 
connexion à Internet.
Remarque : sauf instructions contraires de votre FAI, ignorez les champs Client DHCP 
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Configuration PPPoE
Certains FAI recourant à la technologie DSL utilisent le protocole PPPoE (Point-to-Point 
Protocol over Ethernet)). Si vous utilisez un modem DSL et que vous avez besoin d’un 
nom d’utilisateur et d’un mot de passe pour vous connecter à Internet, contactez votre 
FAI pour savoir si vous devez vous connecter via PPPoE. 
Pour configurer une connexion PPPoE :
Ayez à portée de main le nom d’utilisateur, le mot de passe et, si cela est nécessaire, 
l’adresse du serveur DNS fournis par votre FAI (voir la page 95).
1 Dans préférence Réseau, sélectionnez Ethernet intégré dans le menu local Afficher.
2 Cliquez sur PPPoE et sélectionnez “Se connecter via PPPoE”.
3 Remplissez le reste des champs. Si vous souhaitez que tous les utilisateurs de votre 
ordinateur utilisent la même méthode de connexion, sélectionnez “Enregistrer le mot 
de passe”.
Remarque : pour vous connecter automatiquement au démarrage d’une application 
TCP/IP, telle qu’un navigateur Web ou une application de courrier électronique, cliquez 
sur Options PPPoE, puis sélectionnez “Se connecter automatiquement si nécessaire”.104 Annexe C Connexion à Internet
4 Cliquez sur TCP/IP et sélectionnez Via PPP ou Manuellement dans le menu local 
Configurer IPv4, selon les instructions de votre FAI. Si votre FAI vous a communiqué une 
adresse IP statique, choisissez Manuellement et tapez l’adresse dans le champ Adresse 
IP.
5 Saisissez les adresses des serveurs de noms de domaine (DNS) dans le champ 
Serveurs DNS.
6 Cliquez sur Appliquer.
Votre connexion à Internet est prête dès que vous avez configuré votre réseau. Vous 
pouvez alors ouvrir votre navigateur Web ou une autre application TCP/IP afin de tester 
votre connexion.
Important : si vous n’avez pas sélectionné l’option de connexion automatique, vous 
devez ouvrir l’application Connexion à Internet, choisir la configuration adéquate, puis 
cliquer sur Se connecter. Pour plus d’informations, choisissez Aide > Aide Connexion à 
Internet dans la barre des menus située en haut de l’écran. Annexe C Connexion à Internet 105
Connexion sans fil AirPort Extreme
Vous pouvez configurer votre réseau AirPort Extreme et votre connexion Internet à 
l’aide de l’Assistant réglages AirPort, situé dans le dossier Utilitaires de votre dossier 
Applications. L’assistant vous aide à configurer votre borne d’accès AirPort Extreme et 
à régler votre ordinateur pour qu’il utilise AirPort Extreme. Pour en savoir plus sur votre 
borne d’accès AirPort Extreme, consultez le Guide de configuration de la borne d’accès 
AirPort Extreme livré avec votre borne d’accès.
Si votre borne d’accès AirPort Extreme est déjà configurée, votre carte AirPort Extreme 
peut dans la plupart des cas y accéder immédiatement. 
Pour vérifier l’accès au réseau AirPort Extreme :
m
Cliquez sur l’icône d’état AirPort dans la barre des menus et choisissez un réseau 
AirPort dans la liste.
Si aucun réseau AirPort n’y figure, vous pouvez utiliser l’Assistant réglages AirPort 
pour vérifier ou modifier vos réglages ou bien les changer via la fenêtre Réseau 
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Configuration manuelle d’une connexion AirPort Extreme
Pour configurer une connexion manuelle utilisant des adresses spécifiques affectées 
par avance pour vos serveurs et votre ordinateur, procurez-vous les informations 
suivantes auprès de votre administrateur de système. 
Si vous vous connectez via DHCP, la plupart de ces informations sont automatiquement 
transmises à votre ordinateur via le réseau. Consultez votre administrateur de système 
pour obtenir les renseignements nécessaires.
• Adresses des serveurs de noms de domaine (DNS), si nécessaire
• Configuration d’adresse IP manuelle ou via DHCP
• Adresse IP 
• Adresse du routeur 
• Masque de sous-réseau
• Mot de passe, si nécessaire
Assurez-vous ensuite que les options de connexion AirPort sont activées dans les 
préférences Réseau.
Pour régler vos Préférences réseau pour un port AirPort Extreme :
1 Dans la barre des menus, sélectionnez le menu Pomme (K) > Préférences Système.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez Configurations de ports réseau.
4 Cochez la case Activé à côté d’AirPort.Annexe C Connexion à Internet 107
Suivez ensuite les instructions fournies par votre FAI ou votre administrateur réseau 
pour configurer votre réseau manuellement ou via DHCP. Si vous configurez vousmême votre réseau, il est peut-être plus simple d’utiliser DHCP car le serveur attribue 
automatiquement les adresses IP.
5 Choisissez AirPort dans le menu local Afficher.
6 Cliquez sur TCP/IP, si nécessaire.
7 Dans le menu local Configurer IPv4, choisissez Manuellement ou Via DHCP.
• Si vous choisissez Manuellement, saisissez les autres informations dans les champs 
correspondants. 
• Si vous choisissez Via DHCP, il est inutile de saisir d’autres informations, sauf 
instructions contraires de votre administrateur de système.
8 Cliquez sur AirPort et sélectionnez les options requises pour vous connecter à un 
réseau AirPort Extreme après le redémarrage ou lors de la réactivation de l’ordinateur 
après une suspension d’activité.
9 Cliquez sur Appliquer.
Une fois les réglages AirPort configurés, vous êtes prêt à vous connecter.
Pour tester votre connexion AirPort Extreme :
m
Cliquez sur l’icône d’état AirPort dans la barre des menus et choisissez Activer AirPort.
Tout réseau AirPort Extreme situé dans la zone de couverture doit apparaître 
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Dépannage de votre connexion
Connexion à Internet par modem câble, ligne DSL et réseau LAN
Si vous ne parvenez pas à vous connecter à Internet à l’aide de votre modem câble 
ou DSL ou via votre réseau local (LAN), suivez les étapes ci-après. 
Important : les instructions relatives aux modems ne concernent pas les utilisateurs 
de réseau LAN. Contrairement aux utilisateurs de modems câble et DSL, les utilisateurs 
de réseau LAN peuvent disposer de concentrateurs, de commutateurs, de routeurs et 
autres dispositifs de connexion. Ils doivent faire appel à leur administrateur réseau 
plutôt qu’à un FAI.
Vérifiez les câbles et les sources d’alimentation
Assurez-vous que tous les câbles du modem sont correctement branchés, y compris 
le câble d’alimentation du modem, le câble reliant le modem à l’ordinateur et le câble 
raccordant le modem à la prise murale. Vérifiez les câbles et l’alimentation des routeurs 
et des concentrateurs Ethernet. 
Éteignez puis rallumez le modem et réinitialisez les composants matériels 
du modem.
Éteignez votre modem DSL ou votre modem câble pendant quelques minutes puis 
rallumez-le. Certains FAI conseillent de débrancher le câble d’alimentation du modem. 
Si votre modem dispose d’un bouton de réinitialisation, vous pouvez l’actionner avant 
ou après avoir éteint puis rallumé le modem.Annexe C Connexion à Internet 109
Connexions PPPoE 
Si vous n’arrivez pas à vous connecter à votre FAI via PPPoE, commencez par vérifier 
les câbles et l’alimentation, puis éteignez le modem et rallumez-le et réinitialisez le 
matériel modem. 
Vérifiez les réglages de Préférences Système
1 Dans la barre des menus, sélectionnez le menu Pomme (K) > Préférences Système.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez Configurations de ports réseau.
4 Sélectionnez Ethernet intégré, puis faites glisser cette configuration en haut de la liste 
des configurations de ports. 
5 Dans le menu local Afficher, sélectionnez Ethernet intégré.
6 Cliquez sur PPPoE. 
7 Sélectionnez Se connecter via PPPoE.
8 Vérifiez le champ Nom de compte pour vous assurer d’avoir tapé les informations 
correctes fournies par votre FAI. 
9 Si vous avez choisi d’enregistrer votre mot de passe, saisissez-le à nouveau afin d’être 
sûr(e) qu’il est correct. 
10 Cliquez sur TCP/IP. Assurez-vous d’avoir saisi dans cette fenêtre les informations 
correctes fournies par votre FAI. 
11 Cliquez sur Appliquer.110 Annexe C Connexion à Internet
Connexions au réseau
Si vous disposez de plusieurs ordinateurs tentant de partager une connexion à Internet, 
assurez-vous que votre réseau est correctement configuré. Vous devez savoir si votre 
FAI fournit une seule ou plusieurs adresses IP, autrement dit, une pour chaque 
ordinateur.
Si une seule adresse IP est utilisée, vous devez disposer d’un routeur capable de 
partager la connexion (on parle alors de conversion d’adresse réseau (NAT) ou de 
“masquage d’adresse IP”). Pour obtenir des informations sur la configuration, consultez 
la documentation fournie avec votre routeur ou contactez la personne qui a configuré 
votre réseau. La borne d’accès AirPort Extreme peut être utilisée pour que plusieurs 
ordinateurs partagent une adresse IP. Pour plus d’informations sur l’utilisation de la 
borne d’accès AirPort Extreme, consultez l’aide à l’écran ou rendez-vous sur le site 
Web AirPort, à l’adresse www.apple.com/airport.
Si ces instructions s’avèrent insuffisantes pour résoudre les problèmes rencontrés, 
contactez votre FAI.111
Communications Regulation Information
FCC Compliance Statement
This equipment has been tested and found to 
comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against 
harmful interference in a residential installation.
This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause 
harmful interference to radio communications. 
However, there is no guarantee that interference will 
not occur in a particular installation. If this 
equipment does cause harmful interference to radio 
or television reception, which can be determined by 
turning the equipment off and on, the user is 
encouraged to try to correct the interference by one 
or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment 
and receiver.
• Connect the equipment into an outlet on a circuit 
different from that to which the receiver is 
connected.
• Consult the dealer or an experienced radio/TV 
technician for help.
If necessary, consult an Apple Authorized Service 
Provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician 
for additional suggestions. 
Important: Changes or modifications to this product 
not authorized by Apple Computer, Inc., could void 
the EMC compliance and negate your authority to 
operate the product.
This product was tested for EMC compliance under 
conditions that included the use of Apple peripheral 
devices and Apple shielded cables and connectors 
between system components. It is important that 
you use Apple peripheral devices and shielded 
cables and connectors between system components 
to reduce the possibility of causing interference to 
radios, television sets, and other electronic devices. 
You can obtain Apple peripheral devices and the 
proper shielded cables and connectors through an 
Apple Authorized Reseller. For non-Apple peripheral 
devices, contact the manufacturer or dealer for 
assistance. 
Responsible party (contact for FCC matters 
only): Apple Computer, Inc. Product Compliance, 1 
Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 
408-974-2000.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B 
specifications. Cet appareil numérique de la classe B 
est conforme à la norme NMB-003 du Canada.
VCCI Class B Statement
Communauté Européenne
Conforme aux directives européennes 72/23/CEE, 
89/336/CEE et 99/5/CEE.
Laser Information
Do not attempt to disassemble the cabinet 
containing the laser. The laser beam used in this 
product is harmful to the eyes. The use of optical 
instruments, such as magnifying lenses, with this 
product increases the potential hazard to your eyes. 
For your safety, have this equipment serviced only 
by an Apple Authorized Service Provider. 
If you have an internal Apple CD-ROM, DVD-ROM, or 
DVD-RAM drive in your computer, your computer is 
a Class 1 laser product. The Class 1 label, located in a 
user-accessible area, indicates that the drive meets 
minimum safety requirements. A service warning 
label is located in a service-accessible area. The 
labels on your product may differ slightly from the 
ones shown here. 
Warning: Making adjustments or performing 
procedures other than those specified in your 
equipment’s manual may result in hazardous 
radiation exposure.
Class 1 label Service warning label112
Laser Specifications
Laser on pickup unit (when reading a CD):
• Type: Semiconductor GaAlAs laser
• Wavelength: 790 nm
• Power out of objective lens: 3.3 mW
• Beam divergence: horizontal 12º vertical 35º
Exposure to Radio Frequency Energy
The radiated output power of the optional AirPort 
Extreme Card is far below the FCC radio frequency 
exposure limits. Nevertheless, it is advised to use the 
wireless equipment in such a manner that the 
potential for human contact during normal 
operation is minimized.
Informations sur la souris et le clavier
La souris optique d’Apple est un appareil à diode 
électroluminescente de catégorie 1. Ce produit est 
conforme aux exigences des directives européennes 
72/23/CEE et 89/336/CEE.
It also complies with the Canadian ICES-003 Class B 
Specification.
Avertissement relatif aux activités à haut 
risque
Cet ordinateur n’est pas conçu pour être utilisé dans 
des installations nucléaires, pour la navigation ou la 
communication aérienne, pour le contrôle du trafic 
aérien, ni dans aucune autre situation où une panne 
du système informatique pourrait entraîner la mort, 
des blessures ou de graves dommages écologiques.
Conformité ENERGY STAR®
En tant que partenaire ENERGY STAR® Apple a 
configuré ce produit de telle sorte qu’il respecte les 
recommandations d’économie d’énergie d’ENERGY 
STAR®. Le programme ENERGY STAR® est un 
partenariat avec les fabricants de matériel de bureau 
visant à promouvoir une consommation efficace de 
l’énergie. La réduction de la consommation 
d’énergie des appareils de bureau permet de réaliser 
des économies et contribue à réduire la pollution en 
éliminant le gaspillage d’énergie.
Informations sur l’élimination 
des piles usagées
Les batteries usagées doivent être recyclées ou 
traitées conformément aux normes d’environnement 
locales.
Nederlands
Gebruikte batterijen kunnen worden ingeleverd bij 
de chemokar of in een speciale batterijcontainer 
voor klein chemisch afval (kca) worden 
gedeponeerd.
Informations sur l’élimination 
de l’ordinateur usagé
Votre Power Mac G5 doit être recyclé ou éliminé 
conformément aux lois, normes et directives locales 
pour les matériels électriques et électroniques.
Informations relatives au téléphone et 
au modem Apple 56K
Informez votre opérateur téléphonique
Certains opérateurs téléphoniques exigent que vous 
informiez votre agence locale lorsque vous raccordez 
un modem à leur réseau. 
Information You Need in the United States 
The internal modem complies with Part 68 of the 
FCC rules. On the back of this equipment is a label 
that contains, among other information, the FCC 
registration number and ringer equivalence number 
(REN). If requested, provide this information to your 
telephone company. 
• Ringer equivalence number (REN) : 0.1B (part 
numbers M9455 and M9457) and 0.6B (part 
number M9454). The REN is useful for determining 
the quantity of devices you may connect to your 
telephone lines and still have all those devices ring 
when your telephone number is called. In most, 
but not all areas, the sum of the RENs of all devices 
connected to one line should not exceed five (5.0). 
To be certain of the number of devices you may 
connect to your line, as determined by the REN, 
you should contact your local telephone company 
to determine the maximum REN for your calling 
area. 
• Telephone jack type: USOC, RJ-11 An FCC-compliant 
telephone cord and modular plug are provided 
with this equipment. This equipment is designed 
to be connected to the telephone network or 
premises wiring using a compatible modular jack 
that complies with Part 68 rules. See the 
installation instructions for details.113
Telephone Line Problems
If your telephone doesn’t work, there may be a 
problem with your telephone line. Disconnect the 
modem to see if the problem goes away. If it doesn’t, 
report the problem either to your local telephone 
company or to your company’s telecommunications 
department. 
If disconnecting the modem eliminates the problem, 
the modem itself may need service. Pour obtenir de 
l’assistance, reportez-vous aux informations relatives 
à l’assistance et à la maintenance fournies avec votre 
produit Apple pour vous entrer en contact avec 
Apple ou un fournisseur de services agréé Apple. 
If you do not disconnect your modem when it is 
adversely affecting the telephone line, the telephone 
company has the right to disconnect your service 
temporarily until you correct the problem. The 
telephone company will notify you as soon as 
possible. Also, you will be informed of your right to 
file a complaint with the FCC. 
The telephone company may make changes in its 
facilities, equipment, operations, or procedures that 
could affect the operation of your equipment. If this 
happens, the telephone company will provide 
advance notice in order for you to make the 
necessary modifications to maintain uninterrupted 
service. 
The internal modem will not work with party lines, 
cannot be connected to a coin-operated telephone, 
and may not work with a private branch exchange 
(PBX). 
Telephone Consumer Protection Act 
The Telephone Consumer Protection Act of 1991 
makes it unlawful for any person to use a computer 
or other electronic device to send any message via a 
telephone fax machine unless such message clearly 
contains, in a margin at the top or bottom of each 
transmitted page or on the first page of the 
transmission, the date and time it was sent and an 
identification of the business, other entity, or 
individual sending the message and the telephone 
number of the sending machine of such business, 
entity, or individual.
Information You Need in Canada 
The Industry Canada (IC) label identifies certified 
equipment. This certification means that the 
equipment meets certain telecommunications 
network protective, operational, and safety 
requirements. The Department does not guarantee 
the equipment will operate to a user’s satisfaction. 
Before installing this equipment, make sure that you 
are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an 
acceptable method of connection to install the 
equipment. In some cases, you may extend the 
company’s internal wiring for single-line individual 
service by means of a certified telephone extension 
cord. Be aware, however, that compliance with these 
conditions may not prevent degradation of service 
in some situations. 
Repairs to certified equipment should be made by 
an authorized Canadian maintenance facility 
designated by the supplier. Any equipment 
malfunctions or repairs or alterations that you make 
to this equipment may cause the 
telecommunications company to request that you 
disconnect the equipment. 
In Canada, contact Apple at: 7495 Birchmount Road, 
Markham, Ontario, L3R 5G2, 800-263-3394
Users should not attempt to make such connections 
themselves, but should contact the appropriate 
electric inspection authority or electrician.
• Load number: 0.1 (part numbers M9455 and 
M9457) and 0.2 (part number M9454). The load 
number (LN) assigned to each terminal device 
denotes the percentage of the total load to be 
connected to the telephone loop that is used by 
the device, to prevent overloading. The 
termination of a loop may consist of any 
combination of devices, subject only to the 
requirement that the sum of the load numbers of 
all devices does not exceed 100.
• Telephone jack type: CA-11
Informations destinées aux utilisateurs canadiens
L’étiquette d’Industrie Canada identifie un matériel 
homologué. Cette étiquette certifie que le matériel 
est conforme à certaines normes de protection, 
d’exploitation et de sécurité des réseaux de 
télécommunications. Le Ministère n’assure toutefois 
pas que le matériel fonctionnera à la satisfaction de 
l’utilisateur.
Avant d’installer ce matériel, l’utilisateur doit 
s’assurer qu’il est permis de le raccorder au réseau de 
l’entreprise locale de télécommunication. Le matériel 
doit également être installé en suivant une méthode 
acceptée de raccordement. Dans certains cas, le 
câblage appartenant à l’entreprise utilisé pour un 
service individuel à ligne unique peut être prolongé 
au moyen d’un dispositif homologué de 
raccordement (cordon prolongateur téléphonique).
Warning: Users should ensure for their own 
protection that the electrical ground connections 
of the power utility, telephone lines, and internal 
metallic water pipe system, if present, are 
connected together. This precaution may be 
particularly important in rural areas. 114
L’abonné ne doit pas oublier qu’il est possible que la 
conformité aux conditions énoncées ci-dessus 
n’empêche pas la dégradation du service dans 
certaines situations. De fait, les entreprises de 
télécommunication ne permettent pas que l’on 
raccorde un matériel aux prises d’abonnés, sauf dans 
les cas précis prévus par les tarifs particuliers de ces 
entreprises.
Les réparations de matériel homologué doivent être 
effectuées par un centre d’entretien canadien 
autorisé désigné par le fournisseur. La compagnie de 
télécommunications peut demander à l’utilisateur de 
débrancher un appareil suite à des réparations ou à 
des modifications effectuées par l’utilisateur ou en 
raison d’un mauvais fonctionnement.
Veuillez contacter Apple pour des informations 
supplémentaires :
Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
Service clientèle d’Apple Canada : 800-263-3394
L’utilisateur ne doit pas tenter de faire ces 
raccordements lui-même ; il doit avoir recours à un 
service d’inspection des installations électriques ou à 
un électricien, selon le cas.
• Numéro de charge : 0,2 L’indice de charge (IC) 
assigné à chaque dispositif terminal indique, pour 
éviter toute surcharge, le pourcentage de la 
charge totale qui sera raccordée à un circuit 
téléphonique bouclé utilisé par ce dispositif. La 
terminaison du circuit bouclé peut être constituée 
de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de 
l’ensemble des dispositifs ne dépasse pas 100.
• Type de prise téléphonique : CA-11
Information You Need in the United Kingdom
This terminal equipment is intended for direct 
connection to the analogue Public Switched 
Telecommunications Network and is approved for 
use within the United Kingdom with the following 
features:
• Modem facility
• Autocalling facility
• Autoanswer facility
• DTMF signaling
Operation in the absence of proceed indication or 
upon detection of proceed indication
This product is in conformity with relevant 
regulatory standards following the provisions of 
European Council Directives 73/23/EEC (Low Voltage 
Directive) and 89/336/EEC amended by 92/31/EEC 
(EMC Directive).
Informationen für Deutschland
Diese Modem-Karte ist als Endeinrichtung 
vorgesehen und muss an ein TAE mit F-Kodierung 
angeschlossen werden. Diese Endeinrichtung ist in 
Konformität gemäss Niederspannungsrichtlinie 73 / 
23 / EWG sowie EMC-Richtlinien 89 / 336 / EWG und 
92 / 31 / EWG.
Informations pour la France
Ce matériel est conforme aux normes applicables de 
sécurité électrique d’après la directive 73/23/CEE et 
aux normes applicables de comptabilité 
électromagnétique d’après la directive 89/336/CEE, 
modifiée par la directive 92/31/CEE.
Information You Need in Australia
All telecommunications devices are required to be 
labelled as complying to the Australian 
telecommunications standards, ensuring the health 
and safety of the operator and the integrity of the 
Australian telecommunications network. To provide 
compliance with the Australian Communications 
Authority’s technical standards, please ensure that 
the following AT commands are maintained:
• ATB0 (ITU/CCITT operation)
• AT&G0 (no guard tone)
• AT&P1 (33/66 pulse dial make/break ratio)
• ATS0 = 0 or ATS0 = 1 (no answer or answer greater 
than one ring)
• ATS6 = 95 (DTMF period between 70–255 ms)
• ATS11 = 95 (DTMF period between 70–255 ms)
For calls that are automatically generated, a total of 
three call attempts are allowed to a telephone 
number, with a minimum period between calls of 2 
seconds. If the call does not connect after three 
attempts, 30 minutes must expire before automatic 
redialing may be initiated. Failure to set the modem 
(and any associated communications software) to 
the above settings may result in the modem being 
non-compliant with Australian telecommunications 
standards. Under these circumstances a user could 
be subject to significant penalties under the 
Telecommunications Act 1997.
Avertissement : Pour sa propre sécurité, l’utilisateur 
doit s’assurer que tout les fils de mise à la terre du 
secteur, des lignes téléphoniques et les 
canalisations d’eau métalliques, s’il y en a, soient 
raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions 
rurales.115
This modem must be properly secured in order for 
you to use it. Telecommunications network voltages 
exist inside the computer and the 
telecommunications line connection must be 
removed before opening the computer.
Information You Need in New Zealand
This modem is fully approved to operate on the New 
Zealand telecommunications network under 
Telepermit number PTC 211/04/002 (part numbers 
M9455 and M9457) and PTC 211/01/062 (part 
number M9454). All telecommunications devices are 
required to hold a Telepermit and be labelled 
accordingly with the approved Telepermit number to 
comply with the New Zealand telecommunications 
standards, ensuring the health and safety of the 
operator and the integrity of the New Zealand 
telecommunications network. To ensure compliance, 
all calls that are automatically generated should not 
make more than 10 call attempts to the same 
number within any 30 minute period with a 
minimum period between calls of 30 seconds. 
Failure to adhere to these standards may result in 
the modem being non-compliant with New Zealand 
Telecom standards. Under these circumstances a 
user could be subject to significant penalties.
Important: The grant of a Telepermit for any item of 
terminal equipment indicates that only Telecom has 
accepted that the item complies with minimum 
conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, nor 
does it provide any sort of warranty. Above all, it 
provides no assurance that any item will work 
correctly in all respects with another item of 
Telepermitted equipment of a different make or 
model, nor does it imply that any product is 
compatible with all of Telecom’s network services.
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de votre MacBook
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1
1 Premiers contacts
Votre MacBook comprend les composants suivants : 
Important : lisez attentivement toutes les instructions d’installation (et les consignes 
de sécurité de l’annexe B, «Consignes de sécurité, d’utilisation et d’entretien», à la 
page 113) avant de brancher votre ordinateur sur une prise secteur.
Câble secteur
Télécommande Apple Remote
Fiche 
secteur
Adaptateur secteur MagSafe de 60 W
MENU
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Configuration de votre MacBook
Votre MacBook est conçu pour être configuré rapidement et utilisé immédiatement. 
Les pages suivantes contiennent des informations qui vous guident tout au long du 
processus de configuration, notamment :
Â branchement de l’adaptateur secteur Apple MagSafe de 60 W ;
Â connexion des câbles ;
Â mise sous tension de votre MacBook ;
Â configuration d’un compte d’utilisateur et d’autres paramètres via Assistant réglages.
Étape 1 : branchez l’adaptateur secteur Apple MagSafe de 60 W
Si l’adaptateur secteur est entouré d’un film protecteur, retirez ce dernier avant de 
configurer votre MacBook.
m Branchez la fiche secteur de votre adaptateur sur une prise secteur. Branchez ensuite 
la fiche de l’adaptateur secteur sur le port d’adaptateur secteur du MacBook. Lorsque 
vous rapprochez la fiche du port, vous ressentirez la force d’un aimant attirant la fiche 
de l’adaptateur secteur.
Fiche
secteur
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Pour étendre la portée de votre adaptateur, vous pouvez y connecter le câble d’alimentation secteur. Tirez d’abord sur la fiche secteur pour la retirer de l’adaptateur, puis 
connectez-y le câble d’alimentation secteur inclus. Branchez l’autre extrémité sur une 
prise secteur. Une illustration de cette opération se trouve à la page 33.
Étape 2 : connectez vos câbles
Pour obtenir une connexion Internet, connectez votre MacBook à un modem DSL, 
un modem câble, un modem externe ou un réseau Ethernet. Si vous vous connectez 
à un réseau sans fil tel qu’AirPort Extreme, vous n’avez pas besoin de câbles.
Pour obtenir des informations sur les types de connexions, consultez l’annexe C, 
«Connexion à Internet», à la page 123.
Avertissement : assurez-vous que la fiche secteur est complètement insérée dans 
l’adaptateur et que les broches de votre fiche secteur sont complètement déployées 
avant de brancher l’adaptateur sur la prise secteur.
¯
Câble secteur
Fiche 
secteur
Fiche de l’adaptateur Port de l’adaptateur secteur
secteur
F3626M42.book Page 11 Wednesday, April 5, 2006 2:17 PM12 Chapitre 1 Premiers contacts
Remarque : pour une connexion par ligne téléphonique, vous aurez besoin 
du modem USB externe d’Apple, disponible sur l’Apple Store en ligne à l’adresse 
www.apple.com/francestore ou auprès des revendeurs agréés Apple. Branchez
le modem USB d’Apple dans un port USB du MacBook, puis connectez un câble 
téléphonique (non inclus) entre le modem et une prise téléphonique. 
Pour se connecter à un modem DSL ou câble ou à un réseau Ethernet :
m Connectez le câble à votre modem DSL ou modem câble comme indiqué dans les instructions du modem ou bien connectez le câble Ethernet à un concentrateur ou une prise 
Ethernet. Branchez ensuite l’autre extrémité du câble au port Ethernet de l’ordinateur.
Remarque : si vous souhaitez utiliser AirPort pour vous connecter sans fil, les réseaux 
sans fil disponibles sont détectés lorsque vous allumez votre ordinateur. Si nécessaire, 
choisissez «Activer AirPort» dans le menu d’état AirPort (Z) de la barre des menus, 
puis choisissez votre réseau.
G
Câble 
Ethernet
Port Ethernet Gigabit 
(10/100/1000Base-T)
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Étape 3 : allumez votre MacBook
1 Pour allumer votre MacBook, appuyez rapidement (jusqu’à une seconde) sur le bouton 
d’alimentation (®). 
Votre ordinateur émet un signal sonore lorsque vous l’allumez. Après avoir entendu 
ce signal, n’appuyez pas sur le bouton d’alimentation, car vous risqueriez d’éteindre 
l’ordinateur.
Sa mise en route prend quelques instants. Après le démarrage, Assistant réglages 
s’ouvre automatiquement.
® Bouton d’alimentation
Lampe témoin de 
suspension d’activité
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2 Le trackpad de votre MacBook permet de sélectionner et de déplacer des éléments à 
l’écran de la même façon que la souris d’un ordinateur de bureau. 
Â Pour déplacer le pointeur à l’écran, glissez votre index sur le trackpad. 
Important : n’utilisez qu’un seul doigt sur le trackpad pour déplacer le pointeur. 
Le trackpad vous permet de faire défiler en déplaçant deux doigts. Cette fonction 
est activée par défaut. Pour toute information supplémentaire, consultez la section 
«Utilisation du trackpad» à la page 34.
Â Utilisez le bouton du trackpad pour sélectionner un élément, cliquer ou faire un 
double-clic.
Trackpad Bouton du trackpad
F3626M42.book Page 14 Wednesday, April 5, 2006 2:17 PMChapitre 1 Premiers contacts 15
Étape 4 : configurez votre MacBook à l’aide d’Assistant réglages
La première fois que vous démarrez votre ordinateur, Assistant réglages se met en 
route. Il vous aide à saisir les informations concernant la configuration Internet et 
le courrier électronique et à configurer un compte d’utilisateur sur votre ordinateur. 
Si vous possédez déjà un ordinateur Macintosh, l’Assistant réglages peut vous aider 
à transférer automatiquement les fichiers, les applications et d’autres informations 
depuis votre ancien ordinateur vers votre nouveau MacBook.
Problèmes de mise sous tension de l’ordinateur
Rien ne se produit lorsque vous appuyez sur le bouton d’alimentation (®).
Â La batterie est peut-être déchargée. Assurez-vous que l’adaptateur secteur est fermement connecté à l’ordinateur et relié à une prise secteur. La prise de l’adaptateur 
secteur doit s’éclairer lorsque que vous la branchez sur l’ordinateur.
Â Si l’ordinateur ne démarre toujours pas, consultez la section «Problèmes vous empê-
chant d’utiliser votre ordinateur» à la page 100.
Un point d’interrogation clignotant sur une icône de disque ou de dossier apparaît 
à l’écran.
Cette icône signifie généralement que l’ordinateur ne parvient pas à localiser le logiciel 
système sur le disque dur interne ou sur tout disque externe relié à l’ordinateur. Déconnectez tous les périphériques externes puis essayez de redémarrer. Maintenez enfoncé 
le bouton d’alimentation (®) de 8 à 10 secondes jusqu’à l’arrêt de l’ordinateur. Appuyez 
ensuite de nouveau sur le bouton d’alimentation. Si le problème persiste, vous devrez 
peut-être réinstaller le logiciel système. Voir «Réinstallation des logiciels fournis avec 
votre ordinateur» à la page 106.
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Pour transférer des informations, vérifiez les éléments suivants :
Â Votre autre ordinateur Mac dispose d’un port FireWire intégré et prend en charge 
le mode disque cible FireWire.
Â Votre autre ordinateur Mac fonctionne sous Mac OS X version 10.1 ou ultérieure.
Â Vous disposez d’un câble FireWire standard 6 broches vers 6 broches.
Assistant réglages vous guide tout au long du processus de transfert d’informations ; 
il vous suffit de suivre les instructions à l’écran. Le transfert des informations vers votre 
MacBook n’a aucune conséquence sur les informations qui se trouvent sur l’autre Mac 
(si vous avez partitionné le disque dur du nouveau MacBook, toutes les informations 
présentes sur l’autre Mac seront transférées vers une seule partition).
Assistant réglages vous permet de transférer :
Â les comptes d’utilisateur, y compris les préférences et le courrier électronique ; 
Â les réglages de réseau, pour que votre nouveau MacBook soit automatiquement 
configuré avec les mêmes réglages de réseau que votre autre Mac ;
Â les fichiers et dossiers qui se trouvent sur votre disque dur et sur vos partitions. 
Cela vous permet d’accéder facilement aux fichiers et dossiers que vous utilisiez 
sur votre autre Mac ;
Â le dossier Applications, pour que la plupart des applications que vous utilisiez sur 
votre autre Mac soient installées sur votre nouveau MacBook (vous devrez peut-être 
réinstaller certaines applications transférées).
Important : veillez à ne pas écraser des versions plus récentes d’applications déjà 
installées sur votre MacBook lors du transfert de ces applications.
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Si vous ne comptez pas conserver ou utiliser votre autre Mac, il est préférable de lui 
retirer son autorisation de lecture de musique, de clips vidéo ou de livres audio achetés sur le magasin de musique en ligne iTunes Music Store. Le retrait d’autorisation 
d’accès à un ordinateur empêche toute autre personne de lire la musique, les clips 
vidéo et les livres audio que vous avez achetés et permet de libérer une autre autorisation (un compte iTunes vous permet d’autoriser jusqu’à cinq ordinateurs seulement). 
Pour plus d’informations sur le retrait d’autorisation, ouvrez iTunes et choisissez Aide > 
Aide iTunes et Music Store.
Si vous n’utilisez pas l’Assistant réglages pour transférer vos informations lors du démarrage initial de votre MacBook, vous pouvez le faire ultérieurement. Allez dans le dossier 
Applications, ouvrez le dossier Utilitaires, puis double-cliquez sur Assistant migration.
Remarque : si vous avez utilisé Assistant réglages pour transférer vos informations à 
partir de votre autre Macintosh et que vous souhaitez utiliser l’Assistant migration pour 
transférer à nouveau des informations, assurez-vous que FileVault est désactivé sur l’autre 
Macintosh. Pour désactiver FileVault, ouvrez la fenêtre Sécurité des Préférences Système 
et cliquez sur Désactiver FileVault. Suivez les instructions à l’écran. 
Assistant réglages peut également vous aider à configurer la connexion à Internet de 
votre ordinateur. Pour les particuliers, l’accès à Internet requiert généralement l’ouverture d’un compte auprès d’un fournisseur d’accès à Internet (éventuellement payant). 
Si vous disposez déjà d’un compte Internet, consultez l’annexe C, «Connexion à Internet», à la page 123 pour savoir quelles sont les informations à saisir.
Félicitations, votre ordinateur est prêt !
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Composants de base de votre MacBook
®?
® Bouton d’alimentation
Lampe témoin 
de la caméra
Caméra iSight
Microphone
Haut-parleurs stéréo
Lampe témoin de 
suspension d’activité
Récepteur à infrarouge 
Trackpad 
Bouton du trackpad
Lecteur optique à 
chargement par fente
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Microphone
Permet de capturer des sons directement avec ce microphone intégré (situé à gauche de 
la caméra iSight).
Caméra iSight intégrée et lampe témoin de la caméra
Participez à une vidéoconférence avec d’autres via l’application iChat AV incluse. La lampe 
témoin de la caméra brille lorsque la caméra capture et affiche des données vidéo.
Haut-parleurs stéréo intégrés (3)
Permettent d’écouter de la musique, des films, des jeux et d’autres types de données 
multimédia.
Trackpad
Permet de déplacer le pointeur sur l’écran du MacBook en utilisant un doigt ; inclut 
également une fonction de défilement en utilisant deux doigts sur le trackpad. 
Lampe témoin de suspension d’activité
Une lumière blanche clignote lorsque le MacBook est en suspension d’activité.
Récepteur à infrarouge intégré
Utilisez votre télécommande Apple Remote et le récepteur infrarouge intégré pour 
contrôler votre MacBook à distance.
Lecteur de disque optique à chargement par fente
Votre disque optique peut lire des disques CD et DVD et écrire sur des CD. Si vous disposez 
d’un lecteur SuperDrive, vous pouvez également écrire sur des disques DVD. Consultez 
«Utilisation du lecteur optique» à la page 76 pour obtenir plus de détails.
® Bouton d’alimentation
Permet d’allumer ou d’éteindre votre MacBook ou d’en suspendre l’activité.
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Fonctionnalités du clavier de votre MacBook
esc num F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12 lock 
—
i
C
-
Touche 
de fonction (Fn)
Touches de 
réglage du 
volume
Touches de
réglage de la
luminosité
Touche de
verrouillage
numérique
Touche 
d’éjection 
de disques
Touche 
Silence
Touches de
fonction 
standard
Touche de bascule
du mode vidéo
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Touche de fonction (Fn)
Maintenez cette touche enfoncée pour activer les actions personnalisées affectées aux 
touches de fonction (F1 à F12). Pour apprendre comment personnaliser les touches de 
fonction, choisissez Aide > Aide Mac dans la barre des menus, puis recherchez «touches 
de fonction».
Touches de réglage de la luminosité
Permettent d’augmenter ( ) ou de diminuer ( ) la luminosité de l’écran de votre 
MacBook.
—
Commande Silence
Permet de désactiver le son provenant des haut-parleurs intégrés et du port de sortie 
casque.
- Touches de réglage du volume
Permettent d’augmenter (-) ou de diminuer (–) le volume du son provenant des 
haut-parleurs intégrés et du port de sortie casque.
Touche de verrouillage numérique
Permet d’activer et de désactiver le pavé numérique intégré au clavier du MacBook. Lorsque 
le pavé numérique est activé, une lumière verte brille sur la touche de verouillage numérique.
i Touche de bascule du mode vidéo
Permet de passer du mode double-écran (affichage de votre bureau sur l’écran intégré et 
sur un écran externe) au mode de recopie vidéo (affichage des mêmes informations sur 
les deux écrans) et vice versa.
F11, F12
Par défaut, la touche F11 ouvre Exposé et la touche F12 ouvre Dashboard. 
C Touche d’éjection de disque
Maintenez cette touche enfoncée pour éjecter un disque. Il est également possible 
d’éjecter un disque en faisant glisser son icône dans la Corbeille.
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Composants supplémentaires de votre MacBook
¯
Port Ethernet 
Gigabit (10/100/
1000 Base-T)
G
Logement
de sécurité
Port de sortie 
casque/audio 
numérique 
optique
f
Port d’entrée 
de ligne audio/
audio numérique 
optique
,
Port 
Mini-DVI
£ Port 
FireWire 
400
H Ports 
USB 2.0
Port d
d’adaptateur 
secteur 
MagSafe
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¯ Port de l’adaptateur secteur Apple MagSafe
Branchez-y l’adaptateur secteur Apple MagSafe 60 W fourni pour recharger la batterie de 
votre MacBook.
G Port Ethernet Gigabit (10/100/1000Base-T)
Permet de se connecter soit à un réseau Ethernet haute vitesse, soit à un autre ordinateur 
et de transférer des fichiers. La fonction de détection automatique du port Ethernet détecte 
d’autres périphériques Ethernet sans avoir besoin de câble croisé Ethernet pour établir 
la connexion.
£ Port Mini-DVI (sortie vidéo)
Permet de se connecter à un affichage externe ou à un appareil de projection utilisant un 
connecteur DVI, VGA, composite ou S-Vidéo. Selon le type de périphérique externe auquel 
vous connectez votre ordinateur, utilisez un adaptateur Mini-DVI vers DVI, Mini-DVI vers VGA 
ou Mini-DVI vers Vidéo, tous vendus séparément à l’adresse www.apple.com/francestore.
H Port FireWire 400
Permettent de connecter des périphériques à haute vitesse tels que des caméras vidéo 
numériques et des périphériques de stockage externes.
d
Deux ports haute vitesse USB 2.0 (Universal Serial Bus)
Permettent de connecter des périphériques supplémentaires à votre MacBook, notamment 
imprimantes, unités de stockage externes, appareils photo numériques, modems, claviers ou 
manettes de jeu.
, Port d’entrée de ligne audio/audio numérique optique
Permet de connecter un micro ou un appareil audio numérique à votre MacBook.
f Port de sortie casque/audio numérique optique
Il permet de connecter des haut-parleurs externes, un casque ou des appareils audio 
numériques.
Logement de sécurité
Permet de protéger votre MacBook contre le vol en l’attachant à l’aide d’un câble de 
sécurité (vendu séparément).
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Pour des informations supplémentaires sur ces fonctionnalités, consultez le chapitre 3, 
«Utilisation de votre MacBook», à la page 57.
Extinction ou suspension d’activité de votre MacBook
Une fois que vous avez fini d’utiliser votre MacBook, vous pouvez suspendre son 
activité ou l’éteindre.
Suspension de l’activité de votre MacBook
Suspendez l’activité de votre MacBook si vous ne comptez vous en éloigner que 
quelques instants. Vous pourrez ensuite le réactiver sans avoir à le redémarrer. 
Pour suspendre l’activité de votre ordinateur, procédez de l’une des manières 
suivantes :
Â Rabattez l’écran.
Â Choisissez Pomme () > Suspendre l’activité, dans la barre des menus.
Â Appuyez sur le bouton d’alimentation (®) et cliquez sur Suspendre l’activité dans 
la zone de dialogue qui apparaît.
Â Choisissez le menu Pomme () > Préférences Système, cliquez sur 
Économiseur d’énergie et définissez un délai pour la minuterie de mise en veille.
F3626M42.book Page 24 Wednesday, April 5, 2006 2:17 PMChapitre 1 Premiers contacts 25
Â Maintenez enfoncé le bouton Lecture/Pause (’) de la télécommande Apple Remote 
pendant 3 secondes. 
Pour réactiver l’ordinateur :
Â Si l’écran est fermé, il suffit de l’ouvrir pour réactiver votre MacBook.
Â Si l’écran est déjà ouvert, appuyez sur le bouton d’alimentation (®), sur l’une des 
touches du clavier ou sur un bouton de la télécommande Apple Remote.
Extinction de votre MacBook
Si vous ne comptez pas utiliser votre MacBook pendant un jour ou deux, il est préférable 
de l’éteindre. La lampe témoin de suspension d’activité reste allumée quelques instants 
au moment de l’extinction.
Pour éteindre votre ordinateur, procédez de l’une des manières suivantes :
Â Choisissez Pomme () > Éteindre, dans la barre des menus.
Â Appuyez sur le bouton d’alimentation (®) et cliquez sur Éteindre dans la zone de 
dialogue qui apparaît.
Si vous comptez ranger votre MacBook pour une durée prolongée, consultez la section 
«Rangement de votre MacBook» à la page 117 afin d’obtenir des informations sur les 
mesures à prendre pour éviter que votre batterie ne se décharge complètement.
Avertissement : patientez quelques secondes jusqu’à ce que la lampe témoin de suspension d’activité clignote (signalant que l’activité de l’ordinateur est suspendue et que 
le disque dur a cessé de tourner) avant de déplacer votre MacBook. Tout déplacement 
de votre ordinateur lorsque le disque dur est en train de tourner risque d’endommager 
ce dernier et d’entraîner une perte de données ou l’impossibilité de démarrer à partir 
du disque dur.
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Étalonnage de la batterie
Pour obtenir une autonomie optimale de votre batterie, effectuez son étalonnage 
durant la première semaine d’utilisation de votre MacBook et répétez régulièrement 
cette procédure afin que votre batterie fonctionne à pleine capacité.
Pour étalonner votre batterie :
1 Branchez votre adaptateur secteur et chargez complètement la batterie de votre MacBook 
jusqu’à ce que le témoin lumineux de l’adaptateur passe au vert et que l’icône de la batterie dans la barre des menus indique que la batterie est complètement chargée.
2 Laissez la batterie complètement rechargée pendant deux heures ou plus. Vous pouvez 
utiliser votre ordinateur durant cette période à condition de brancher l’adaptateur secteur.
3 Débranchez l’adaptateur secteur en gardant le MacBook allumé et commencez à l’utiliser 
avec la batterie. Vous pouvez utiliser votre ordinateur durant cette période. 
Lorsque votre batterie est presque déchargée, un message d’avertissement apparaît
à l’écran. 
4 Gardez votre ordinateur allumé jusqu’à ce qu’il suspende son activité. Enregistrez votre 
travail et fermez toutes les applications lorsque la batterie est presque déchargée et 
avant que le système ne suspende son activité. 
5 Éteignez l’ordinateur ou mettez-le en mode de suspension d’activité pendant cinq heures 
ou plus.
6 Connectez l’adaptateur secteur jusqu’à ce que la batterie soit complètement rechargée. 
Important : recommencez la procédure d’étalonnage environ tous les deux mois afin 
de maintenir votre batterie dans un état optimal. Si vous n’utilisez pas fréquemment 
votre MacBook, il est préférable d’étalonner à nouveau la batterie au moins une fois 
par mois.
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Si vous avez acheté des batteries supplémentaires, appliquez-leur également la procédure 
d’étalonnage. Pour plus d’informations, consultez la section «Utilisation de la batterie» à la 
page 81.
Informations supplémentaires
Pour en savoir plus sur votre MacBook, consultez les ressources suivantes :
Â Consultez le chapitre 2, «Familiarisation avec votre MacBook», à la page 29, pour 
découvrir les notions importantes élémentaires.
Â Si vous n’êtes pas familiarisé avec Mac OS X, lisez le fascicule Bienvenue sur Tiger livré 
avec votre ordinateur et ouvrez l’Aide Mac pour y explorer les informations disponibles. 
Pour plus d’informations, consultez la section «Obtention de réponses grâce à l’Aide 
Mac» à la page 28.
Â Si un problème vous empêche d’utiliser votre ordinateur, consultez le chapitre 5, 
«Dépannage», à la page 99.
Â Consultez les questions les plus fréquemment posées dans «Les dix questions principales» à la page 133 .
Â Pour plus d’information sur l’assistance, les groupes de discussion et les dernières 
nouveautés logicielles Apple à télécharger, visitez le site www.apple.com/fr/support.
Â Si vous ne trouvez pas de réponse à votre problème, consultez le Guide de service et 
support AppleCare qui accompagne votre ordinateur pour savoir comment joindre 
Apple.
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Obtention de réponses grâce à l’Aide Mac
La plupart des informations sur l’utilisation de votre Macintosh sont disponibles 
directement sur votre ordinateur, dans l’Aide Mac.
Pour faire apparaître l’Aide Mac :
1 Cliquez sur l’icône Finder dans le Dock (barre d’icônes située au bas de l’écran).
2 Choisissez Aide > Aide Mac (cliquez sur le menu Aide dans la barre des menus puis 
sélectionnez Aide Mac).
3 Cliquez dans le champ Rechercher, tapez votre question et appuyez sur la touche 
Retour du clavier.
Champ Rechercher
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2
2 Familiarisation avec 
votre MacBook
Ce chapitre présente des notions élémentaires 
importantes concernant votre MacBook. 
Lorsque vous cessez d’utiliser votre MacBook, patientez quelques instants avant de 
transporter l’ordinateur afin de laisser le temps au disque dur ou à tout disque optique 
situé dans votre lecteur (CD ou DVD) d’arrêter de tourner. Évitez de bousculer ou de 
heurter votre MacBook pendant que des disques sont en train de tourner.
Remarque : votre MacBook utilise la technologie Sudden Motion Sensor qui contribue 
à protéger le disque dur en cas de chute ou de vibrations subies par l’ordinateur. Pour 
plus de détails, consultez la section «Technologie Sudden Motion Sensor» à la page 81.
Lorsque vous utilisez votre MacBook ou que vous rechargez sa batterie, il est normal 
de constater une augmentation de la température de la partie inférieure du boîtier. 
En cas d’utilisation prolongée, placez votre MacBook sur une surface plane et stable. 
Le dessous du boîtier est légèrement surélevé pour permettre la circulation d’air et 
assurer ainsi à l’équipement une température de fonctionnement normale.
F3626M42.book Page 29 Wednesday, April 5, 2006 2:17 PM30 Chapitre 2 Familiarisation avec votre MacBook
Vous entendrez parfois de petits bruits émis par le système au démarrage ou lorsque 
le lecteur de disque dur et le lecteur optique sont utilisés. De même, il arrive qu’après 
une certaine période de fonctionnement du MacBook, un petit ventilateur se mette en 
marche pour refroidir le système, ce qui peut produire un léger bruit. Ce genre de sons, 
qu’émet le système, font partie du fonctionnement normal de votre ordinateur.
Pour obtenir plus de consignes de sécurité sur la manipulation et l’utilisation de votre 
MacBook dans différents lieux, veuillez consulter l’annexe B, «Consignes de sécurité, 
d’utilisation et d’entretien», à la page 113.
Le reste du présent chapitre comprend des sections concernant l’utilisation des composants de votre MacBook, notamment l’affichage, l’adaptateur secteur, le trackpad, 
le clavier, la caméra iSight intégrée et la télécommande Apple Remote. Vous trouverez 
également des informations sur Mac OS X, l’Aide Mac, les applications et la connexion 
de périphériques.
Réglage de l’écran
Après avoir commencé à travailler sur votre nouvel MacBook, réglez si nécessaire 
la luminosité de l’écran pour un meilleur confort visuel. Utilisez les touches F1 et F2 
portant l’icône de luminosité (¤) pour régler la luminosité de l’écran.
Pour régler les préférences de votre écran dans le but d’optimiser la durée de vie de 
la batterie :
1 Ouvrez Préférences Système puis cliquez sur Économiseur d’énergie.
2 Dans le menu local «Réglages de», choisissez Batterie puis cliquez sur Options.
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3 Décochez la case «Réduire la luminosité de l’écran lors de l’utilisation de cette source 
d’énergie» si vous ne souhaitez pas que votre écran s’assombrisse pour réduire la 
consommation de la batterie.
Lorsque cette fonction est activée, votre écran s’assombrit légèrement lorsque vous passez de l’utilisation de l’adaptateur secteur à celle de la batterie. Lorsque vous branchez à 
nouveau l’adaptateur secteur, votre écran revient à son niveau précédent de luminosité.
Décochez la case «Réduire automatiquement la luminosité de l’écran avant sa mise 
en veille» si vous ne souhaitez pas que l’écran s’assombrisse avant que le MacBook 
ne suspende son activité.
Modification de la taille des images à l’écran
Votre MacBook est équipé d’un écran large de 13,3 pouces doté d’une résolution par 
défaut de 1280 x 800. Vous pouvez modifier la taille des images affichées en réglant 
la résolution de l’écran. 
Vous pouvez choisir une résolution inférieure dans la fenêtre Moniteurs des 
Préférences Système. Lorsque vous diminuez la résolution, les éléments apparaissent plus 
grands à l’écran et sont par conséquent plus faciles à visualiser. Les résolutions réduites 
ne sont cependant pas toujours aussi nettes que la résolution d’écran par défaut.
Lorsque vous employez certaines résolutions, deux bandes noires apparaissent des deux 
côtés de l’écran. Si vous souhaitez supprimer ces bandes, vous pouvez choisir une version 
«étirée» de la résolution, afin que l’image couvre l’ensemble de l’écran et les bandes.
Pour changer la résolution de votre écran :
m Choisissez le menu Pomme () > Préférences Système dans la barre des menus. 
Ouvrez la fenêtre Moniteurs des Préférences Système. 
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Pour changer la résolution de votre écran via le menu d’état Moniteurs de la barre des 
menus, cliquez sur l’option «Ouvrir Moniteurs dans la barre des menus».
Utilisation de l’adaptateur secteur
Le branchement de l’adaptateur secteur alimente le MacBook et recharge sa batterie.
Important : pour des performances optimales, n’utilisez que l’adaptateur secteur livré 
avec votre ordinateur ou procurez-vous un adaptateur secteur MagSafe Apple de 60 W 
supplémentaire.
La première fois que vous connectez l’adaptateur secteur à votre ordinateur, une lampe 
témoin placée sur la fiche de l’adaptateur s’illumine. Une lumière orange indique que 
la batterie est alimentée. Une lumière verte indique que la batterie n’est pas alimentée, 
ce qui peut signifier que la batterie est complètement rechargée, n’est pas installée ou 
présente un problème. Si vous ne voyez pas de lampe témoin, votre fiche n’est probablement pas branchée correctement. Si des débris sont présents, enlevez-les. Vous 
pouvez contrôler le niveau de la batterie soit à l’aide du menu d’état Batterie de la 
barre des menus, soit en vérifiant les lampes témoins de niveau de la batterie situés 
sur la partie inférieure de la batterie (voir la page 81).
Avertissement : le port d’adaptateur secteur du MacBook contient un aimant qui peut 
effacer les données d’une carte de crédit, d’un iPod ou d’autres périphériques. Pour 
préserver vos données, maintenez-les, ainsi que les autres supports magnétiques, à 
distance du port d’adaptateur secteur.
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Pour rallonger le câble de l’adaptateur secteur, tirez d’abord sur la fiche secteur pour la 
retirer de l’adaptateur. Connectez le câble secteur inclus à l’adaptateur, en vous assurant 
qu’il est fermement connecté. Branchez l’autre extrémité sur une prise secteur. Le câble 
d’alimentation secteur fournit une connexion avec mise à la terre.
Utilisez le câble d’alimentation secteur et connectez-le à une prise secteur de terre 
chaque fois que cela est possible. Utilisez uniquement le câble d’alimentation secteur 
fourni avec votre adaptateur secteur. Veillez à ce que le connecteur soit fermement 
engagé dans le port de l’adaptateur secteur de l’ordinateur afin de garantir l’arrivée 
de courant à l’ordinateur. Si le câble est correctement branché, une lampe témoin 
s’allume à l’extrémité du câble branché sur votre MacBook .
Lorsque vous déconnectez l’adaptateur secteur d’une prise de courant ou de l’ordinateur, débranchez la prise et non le câble. Pour obtenir des consignes de sécurité concernant l’utilisation de votre adaptateur secteur, consultez la section «Configuration de 
votre MacBook et de l’adaptateur secteur» à la page 115.
Câble secteur Fiche secteur
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Utilisation du trackpad
La distance de déplacement du pointeur à l’écran dépend de la vitesse à laquelle vous 
déplacez votre doigt sur le trackpad. Pour déplacer le pointeur sur une courte distance 
à l’écran, faites glisser l’index lentement sur le trackpad ; plus le déplacement du doigt 
est rapide, plus la distance parcourue par le pointeur à l’écran est grande. Vous pouvez 
également régler la vitesse de déplacement dans la fenêtre Clavier et souris des 
Préférences Système.
Vous pouvez faire défiler verticalement ou horizontalement une fenêtre munie de 
barres de défilement en déplaçant deux doigts sur le trackpad. Vous pouvez activer 
ou désactiver cette option dans la fenêtre Clavier et souris des Préférences Système. 
Conseils d’utilisation du trackpad
Pour optimiser votre utilisation du trackpad :
Â N’utilisez qu’un seul doigt, sauf si la fonction de défilement est activée et que vous 
souhaitez l’utiliser. 
Â N’utilisez pas de stylo ou tout autre objet. 
Â Veillez à ce que votre doigt et le trackpad soient secs. Si l’humidité ou la condensation 
provoque une accumulation de buée sur le trackpad, essuyez-le avec un chiffon propre 
avant de l’utiliser. 
Â N’utilisez jamais de produit nettoyant sur le trackpad.
Pour en savoir plus sur l’utilisation du trackpad, choisissez Aide > Aide Mac dans 
la barre des menus, en haut de l’écran.
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En plus d’utiliser le bouton du trackpad, vous pouvez utiliser votre doigt pour cliquer 
ou double-cliquer directement sur le trackpad. Les options du trackpad peuvent être 
activées via la fenêtre Clavier et souris des Préférences Système.
Remarque : s’il vous arrive souvent que le pointeur bouge lorsque vous tapez parce que 
vous effleurez le trackpad par inadvertance, sélectionnez l’option «Ignorer les utilisations 
accidentelles du trackpad» dans la fenêtre Clavier et souris des Préférences Système.
Utilisation du clavier
Votre MacBook est équipé d’un pavé numérique intégré au sein des touches normales 
du clavier. Les touches utilisées par le pavé numérique sont pourvues d’une indication 
secondaire.
Touche de 
verrouillage
numérique
Pavé numérique
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Pour utiliser le pavé numérique, appuyez sur la touche de verrouillage numérique. 
Lorsque le pavé numérique est actif, l’indicateur de la touche de verrouillage numérique 
brille. Lorsque vous avez fini de l’utiliser, appuyez à nouveau sur la touche de verrouillage 
numérique pour le désactiver. 
Important : si votre clavier ne semble pas fonctionner correctement, vérifiez la touche 
de verrouillage numérique. Lorsque le pavé numérique est activé, les autres touches 
et raccourcis clavier correspondant à des commandes de menu (comme x + Q pour 
quitter l’application en cours) sont désactivées.
Vous pouvez utiliser votre clavier ou la télécommande Apple Remote pour contrôler 
l’application Front Row. (Voir «Utilisation du clavier pour contrôler Front Row» à la 
page 42.)
Si vous souhaitez utiliser les raccourcis clavier pour travailler de manière plus efficace, 
ouvrez l’Aide Mac et recherchez «raccourcis de clavier». Vous y trouverez une liste complète 
de raccourcis clavier pour un grand nombre de procédures et d’applications courantes.
Utilisation d’une souris
Si vous disposez d’une souris Apple dotée d’un connecteur USB, insérez celui-ci dans le port 
USB 2.0 pour l’utiliser immédiatement. Si vous possédez une souris Apple Wireless Mouse, 
consultez la section «Utilisation de la technologie sans fil Bluetooth» à la page 67 pour 
obtenir des informations sur son utilisation. Vous pouvez vous procurer une souris sans 
fil ou USB sur l’Apple Store en ligne à l’adresse www.apple.com/francestore ou chez un 
revendeur agréé Apple.
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Utilisation de la télécommande Apple Remote et de Front Row
Votre télécommande Apple Remote fonctionne avec l’interface de Front Row et le 
récepteur infrarouge intégré, situé en bas et à droit de la face avant de votre MacBook. 
Utilisez la télécommande Apple Remote pour ouvrir Front Row et interagir à distance 
avec entre autres iTunes, iPhoto, iMovie et Lecteur DVD.
Utilisez votre télécommande Apple Remote pour :
Â ouvrir Front Row et parcourir les menus Musique, Photos, Clips vidéo et DVD ;
Â régler le volume d’un morceau, lire ou mettre en pause un morceau ou passer à 
la piste suivante ou précédente dans iTunes ; 
Â visualiser un diaporama à partir d’un album photo dans iPhoto ; 
Â lire des séquences dans votre dossier Séquences ou regarder des bandes-annonces 
QuickTime en ligne ; 
Â lire un disque DVD dans votre lecteur optique avec Lecteur DVD ;
Â parcourir les présentations Keynote ;
Â suspendre l’activité de votre MacBook ou le réactiver.
Pour utiliser votre télécommande Apple Remote avec Front Row, dirigez-la vers 
l’avant du MacBook et :
Â appuyez sur le bouton Menu (») pour ouvrir ou fermer Front Row ou pour revenir 
au menu précédent lorsque vous explorez Front Row ;
Â appuyez sur le bouton Suivant/Avance rapide (‘) ou sur le bouton Précédent/
Retour rapide (]) pour passer d’une application à l’autre dans Front Row ;
Â appuyez sur les boutons Augmenter le volume/Élément de menu précédent (∂) et 
Baisser le volume/Élément de menu suivant (D) pour vous déplacer parmi les options 
d’un menu ou régler le volume ;
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Â appuyez sur le bouton Sélection/Lecture/Pause (’) pour sélectionner un élément de 
menu ou pour lire ou mettre en pause un morceau, un diaporama ou un DVD ;
Â appuyez sur le bouton Suivant/Avance rapide (‘) ou sur le bouton Précédent/Retour 
rapide (]) pour explorer votre contenu multimédia (maintenez les boutons enfoncés 
pour accélérer le défilement) ;
Â maintenez le bouton Sélection/Lecture/Pause (’) enfoncé pendant 3 secondes pour 
suspendre l’activité de votre MacBook.
Bouton Suivant/Avance rapide
Bouton Sélection/Lecture/Pause
Compartiment de la pile
Bouton Augmenter 
le volume/Élément 
de menu précédent
Fenêtre infrarouge
Bouton Baisser le volume/
Élément de menu suivant
Bouton Précédent/
Retour rapide
Bouton Menu
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Utilisation de la télécommande Apple Remote avec Keynote
Si Keynote est installé sur votre ordinateur, vous pouvez contrôler vos présentations 
avec la télécommande Apple Remote. Une fois Keynote ouvert, appuyez sur le bouton 
Sélection/Lecture/Pause (’) pour lancer une présentation. Ensuite, selon l’endroit de 
l’application où vous souhaitez travailler (dans une présentation ou dans le classeur de 
diapositives), dirigez la télécommande Apple Remote vers votre MacBook et appuyez 
sur ses boutons pour contrôler Keynote suivant les indications du tableau suivant.
Appuyez sur le bouton... dans une présentation dans le classeur de diapositives
’ (Sélection/Lecture/Pause) pour interrompre/reprendre 
la présentation
pour passer à la diapositive 
sélectionnée
» (Menu) pour lancer le classeur de 
diapositives
pour quitter le classeur de 
diapositives
» et maintenez-le enfoncé pour quitter l’application pour quitter la présentation
] (Précédent/Retour rapide) pour passer à la diapositive 
précédente
pour sélectionner la diapositive 
précédente
] et maintenez-le enfoncé pour passer à la première 
diapositive
‘ (Suivant/avance rapide) pour passer à la diapositive 
suivante
pour sélectionner la diapositive 
suivante
‘ et maintenez-le enfoncé pour passer à la dernière 
diapositive
∂ (Augmenter le volume/
Élément de menu précédent) 
pour augmenter le volume pour augmenter le volume
D (Baisser le volume/
Élément de menu suivant)
pour baisser le volume pour baisser le volume
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Jumelage de votre télécommande Apple Remote
Si vous possédez dans une pièce plusieurs ordinateurs ou autres appareils dotés de 
récepteurs à infrarouge intégrés (par exemple, plusieurs MacBook ou iMac dans un 
bureau personnel ou un laboratoire), vous avez la possibilité de «jumeler» votre télé-
commande Apple Remote avec un ordinateur ou un appareil précis. Le jumelage 
permet de configurer l’ordinateur ou l’appareil récepteur de façon à ce qu’il ne soit 
contrôlé que par une télécommande Apple Remote spécifique. 
Pour jumeler votre télécommande Apple Remote avec votre MacBook :
1 Mettez la télécommande Apple Remote à 8 à 10 centimètres du récepteur infrarouge 
de votre MacBook. 
2 Maintenez simultanément enfoncés les boutons Menu (») et Suivant/Avance rapide (‘) 
de votre télécommande Apple Remote pendant 5 secondes.
Lorsque vous avez correctement jumelé votre télécommande Apple Remote avec votre 
MacBook, le symbole d’un maillon de chaîne ( ) apparaît à l’écran.
Pour annuler le jumelage de la télécommande Apple Remote et du MacBook :
1 Choisissez le menu Pomme () > Préférences Système dans la barre des menus.
2 Cliquez sur Sécurité puis sur Désactiver le jumelage.
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Remplacement de la batterie
La télécommande Apple Remote inclut une pile non rechargeable. Si nécessaire, 
remplacez la pile par une pile CR 2032. N’essayez pas de recharger la pile.
Pour remettre la pile en place :
1 Ouvrez le logement de la pile en appuyant sur le bouton (illustré ci-dessus) avec un 
petit objet, tel que l’extrémité d’un trombone.
2 Ôtez le compartiment de la pile et retirez-la.
3 Insérez la nouvelle pile, son côté positif (+) tourné vers le haut.
4 Refermez le logement de la pile.
Appuyez sur ce bouton à l’aide d’un petit objet arrondi 
pour éjecter partiellement le logement de la pile.
Face positive (+) vers le haut.
Tirez afin de libérer le 
logement de la pile.
MENU
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Désactivation de la réception infrarouge
Vous pouvez utiliser les préférences Sécurité pour activer ou désactiver la réception 
infrarouge sur votre MacBook. 
Pour désactiver la réception infrarouge :
Â Choisissez le menu Pomme () > Préférences Système dans la barre des menus et 
cliquez sur Sécurité.
Â Cochez la case «Désactiver le récepteur à infrarouge de la télécommande».
Utilisation du clavier pour contrôler Front Row
Vous pouvez utiliser votre clavier au lieu de la télécommande Apple Remote pour 
contrôler Front Row. Les touches suivantes correspondent aux boutons de la télécommande Apple Remote :
Équivalent clavier Bouton de la télécommande Apple Remote
Commande (x) - Échap Ouvrir menu (»)
Échap Quitter menu (»)
Espace ou Retour Sélection/Lecture/Pause (’)
Flèche vers le haut (Ò) Augmenter le volume/Élément de menu précédent (∂)
Flèche vers la bas (¬) Baisser le volume/Élément de menu suivant (D)
Flèche vers la droite (˚) Suivant/avance rapide (‘)
Flèche vers la gauche (k) Précédent/Retour rapide (])
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En savoir plus sur la télécommande Apple Remote
L’Aide Mac fournit des informations supplémentaires sur la télécommande Apple Remote. 
Choisissez Aide > Aide Mac dans la barre des menus, puis recherchez «Apple Remote». 
Utilisation de la caméra vidéo iSight intégrée
À l’aide de la caméra iSight intégrée, vous pouvez prendre des photos avec 
Photo Booth ou participer à des conférences vidéo avec d’autres utilisateurs d’iChat AV.
Prise de photos avec Photo Booth
Utilisez Photo Booth pour prendre des photos et ajouter des effets visuels amusants 
tels que sépia, noir et blanc, éclat, crayon de couleur et plus encore.
Caméra iSight
Lampe témoin
de la caméra
Microphone 
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Pour prendre une photo avec Photo Booth :
1 Cliquez sur l’icône de Photo Booth dans le Dock pour ouvrir Photo Booth, puis allumez 
la caméra iSight intégrée.
La lampe témoin située à côté de la caméra brille lorsque celle-ci est allumée.
2 Vous pouvez sélectionner un effet à appliquer à votre photo.
3 Cliquez sur l’icône de caméra sous l’image pour prendre une photo.
Enregistrez l’image comme photo de contact iChat, envoyez-la par courrier électronique 
à vos amis ou enregistrez-la dans votre photothèque iPhoto.
Pour utiliser une photo comme photo de contact ou de compte :
1 Ouvrez Photo Booth et prenez une photo.
2 Sélectionnez la photo que vous souhaitez utiliser comme photo de contact ou photo 
de compte.
3 Cliquez sur l’icône de photo de contact ou de compte pour automatiquement mettre 
à jour votre photo.
Pour plus d’informations sur Photo Booth, choisissez Aide > Aide Mac dans la barre des 
menus, puis sélectionnez Centre d’aide > Aide Photo Booth.
Utilisation de votre caméra iSight avec iMovie HD 
Vous pouvez capturer de la vidéo en direct de votre caméra iSight, directement dans 
iMovie HD.
Pour capturer de la vidéo en direct :
1 Ouvrez iMovie HD en cliquant sur son icône dans le Dock.
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2 Cliquez sur l’option de changement de mode pour régler iMovie HD sur le mode 
caméra intégrée.
3 Cliquez sur l’icône de caméra à gauche de l’option de changement de mode puis 
choisissez iSight intégrée dans le menu local.
4 Cliquez sur le bouton «Enregistrer avec iSight» dans le moniteur iMovie pour commencer 
à enregistrer. La vidéo que vous voyez dans le moniteur iMovie est enregistrée comme 
clip dans le panneau des clips iMovie.
5 Cliquez à nouveau sur le bouton «Enregistrer avec iSight» pour arrêter l’enregistrement. 
Vous pouvez enregistrer de la vidéo tant que votre MacBook possède suffisamment 
d’espace libre.
L’Aide Mac fournit des informations supplémentaires sur iMovie HD. Choisissez Aide > 
Aide Mac dans la barre de menus, puis choisissez Centre d’aide > Aide iMovie HD.
Vidéoconférences avec iChat AV
Lorsque vous ouvrez iChat AV, la lampe témoin de la caméra s’allume. Cliquez sur 
l’icône vidéo d’un contact pour participer avec lui à une vidéoconférence iChat AV, 
en temps réel avec animation vidéo intégrale. Votre MacBook est également doté d’un 
micro intégré, ce qui vous permet de profiter à la fois du son et de l’image durant vos 
vidéoconférences iChat AV.
Option de changement de mode
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Pour utiliser la caméra iSight intégrée en vue de lancer une vidéoconférence, vous avez 
besoin des éléments suivants :
Â un compte .Mac, America Online (AOL) ou AOL Instant Messenger (AIM) (requis pour 
iChat AV) ;
Â une connexion à Internet à haut débit via câble modem ou DSL ou un réseau local (LAN). 
Veuillez notez que les vidéoconférences ne sont pas possibles sous une connexion à 
Internet par ligne commutée.
Pour débuter une vidéoconférence :
1 Ouvrez iChat AV.
2 Cliquez sur le bouton représentant une caméra situé à côté d’un contact dans votre 
liste de contacts. 
Pour en savoir plus sur l’ajout de contacts à votre liste, choisissez Aide > Aide iChat AV.
Lorsque vous cliquez sur un bouton représentant une caméra dans la liste des contacts, 
la lampe témoin de la caméra brille pour indiquer que vous affichez de la vidéo. Cela 
enverra également une invitation à votre contact et vous permettra de voir de quoi vous 
avez l’air à la caméra. Lorsqu’un contact accepte votre invitation, vous pouvez le voir 
apparaître sur votre écran, ainsi que vous-même. 
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Vidéoconférence avec plusieurs contacts
Il est possible de réaliser des vidéoconférences en compagnie de deux, et jusqu’à trois, 
contacts à la fois. Un des contacts accueille la vidéoconférence et les autres y participent. 
Pour débuter une vidéoconférence avec plusieurs contacts :
1 Ouvrez iChat AV.
2 Maintenez enfoncée la touche Commande tout en sélectionnant les contacts que vous 
souhaitez inviter. 
3 Cliquez sur le bouton représentant une caméra situé au bas de votre liste de contacts.
Extinction de la caméra iSight
Pour éteindre la caméra iSight, fermez la fenêtre active iChat. La lampe témoin de la 
caméra s’éteint, ce qui indique que la caméra iSight est éteinte et que l’enregistrement 
a été interrompu.
Utilisation de votre photo en tant qu’image de contact
Vous avez la possibilité de vous prendre en photo à l’aide de la caméra iSight et d’utiliser 
cette photo comme image de contact. Elle apparaîtra dans la liste de contacts des autres 
utilisateurs, si vous en faites partie. 
Pour définir votre image de contact :
1 Ouvrez iChat AV.
2 Choisissez Contacts > Changer ma photo.
3 Cliquez sur le bouton représentant une caméra.
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À propos de Mac OS X
Votre ordinateur est doté de Mac OS X version 10.4 Tiger qui comprend entre autres 
Spotlight (un moteur de recherche qui répertorie automatiquement l’ensemble de vos 
fichiers), Dashboard (qui vous permet de garder à portée de mains des «widgets», ou 
mini-applications, très pratiques) et Exposé (qui dispose et affiche de manière élégante 
toutes les fenêtres des applications ouvertes).
Lorsque vous serez prêt à en apprendre davantage sur Mac OS X et les applications iLife 
maintes fois primées qui accompagnent votre ordinateur, consultez le livret Bienvenue 
sur Tiger fourni avec votre MacBook ou consultez les informations dans l’Aide Mac. En 
cas de problèmes lors de l’utilisation de Mac OS X, consultez le chapitre 5, «Dépannage», ou l’Aide Mac.
Pour obtenir des informations sur les applications qui sont compatibles avec Mac OS X 
ou pour en savoir plus sur Mac OS X en général, consultez le site web d’Apple à l’adresse 
www.apple.com/fr/macosx.
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Personnalisation du bureau et réglage des préférences
Grâce aux Préférences Système, vous pouvez donner à votre bureau l’apparence 
souhaitée sans perdre de temps. Choisissez le menu Pomme () > Préférences Système 
dans la barre des menus. 
N’hésitez pas à expérimenter avec les réglages apparaissant dans les fenêtres suivantes :
Â Apparence : sélectionnez cette fenêtre de préférences pour changer entre autres 
la couleur des boutons, menus et fenêtres, ainsi que celle de mise en surbrillance.
Â Dashboard et Exposé : sélectionnez cette fenêtre des Préférences pour définir les 
coins d’écran actifs et les raccourcis de Dashboard, de votre bureau, des fenêtres 
de l’application ainsi que de toutes les fenêtres.
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Â Bureau et économiseur d’écran : sélectionnez cette fenêtre de préférences pour changer 
la couleur et le motif du bureau ou pour le remplacer par la photo ou l’image de votre 
choix. Vous pouvez également choisir un effet d’écran accrocheur qui apparaîtra lorsque 
l’ordinateur reste inactif.
Â Dock : sélectionnez cette fenêtre de préférences pour modifier la taille, l’emplacement 
et le comportement de votre Dock (c’est-à-dire, la barre d’icônes au bas de votre écran).
Tout en vous familiarisant avec votre ordinateur, découvrez progressivement les autres 
Préférences Système. Préférences Système constitue le poste de commande qui vous 
permet d’effectuer la plupart des réglages de votre MacBook. Pour en savoir plus, 
ouvrez l’Aide Mac et recherchez «Préférences Système» ou la fenêtre de préférences 
spécifique que vous souhaitez modifier.
Remarque : Apple publiant régulièrement de nouvelles versions et mises à jour de son 
logiciel système, ses applications et ses sites Internet, il est possible que les illustrations 
figurant dans ce manuel diffèrent légèrement de celles qui apparaissent sur votre écran.
Utilisation des applications
Votre MacBook est accompagné d’applications logicielles vous permettant d’envoyer 
des messages électroniques, de naviguer sur Internet et de bavarder en ligne. Il inclut 
également la suite d’applications iLife, utile par exemple pour l’organisation de votre 
musique et de vos photos numériques, la création de séquences et de sites web. Pour 
en savoir plus sur ces applications, consultez le livret Bienvenue sur Tiger fourni avec 
votre ordinateur.
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Lorsqu’une application ne répond plus
Il peut arriver, très rarement, qu’une application se «fige» à l’écran. Mac OS X permet 
de quitter une application figée sans redémarrer votre ordinateur. Vous pouvez ainsi 
enregistrer le travail effectué dans d’autres applications ouvertes.
Pour forcer une application à se fermer :
1 Appuyez sur les touches Commande (x) + Option + Échap ou choisissez Pomme () > 
Forcer à quitter dans la barre des menus.
La boîte de dialogue Forcer à quitter des applications apparaît. L’application est 
sélectionnée.
2 Dans la zone de confirmation, cliquez sur Forcer à quitter.
L’application se ferme, en laissant toutes les autres applications ouvertes.
Si nécessaire, vous pouvez également redémarrer le Finder à partir de cette zone de 
dialogue.
Si vous rencontrez d’autres difficultés avec une application, consultez le chapitre 5, 
«Dépannage», à la page 99.
Maintien à jour de vos logiciels
Vous pouvez vous connecter à Internet pour télécharger et installer automatiquement les 
dernières versions de logiciels, gestionnaires et autres améliorations fournies par Apple. 
Chaque fois que vous vous connectez à Internet, «Mise à jour de logiciels» consulte 
les serveurs Internet d’Apple pour rechercher les mises à jour disponibles pour votre 
ordinateur. Vous pouvez configurer votre Mac pour qu’il recherche régulièrement dans 
les serveurs Apple des mises à jour de logiciels, puis les télécharge et les installe.
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Pour rechercher des logiciels mis à jour :
1 Ouvrez les Préférences Système. 
2 Cliquez sur l’icône «Mise à jour de logiciels» et suivez les instructions à l’écran.
Â Pour plus d’informations, recherchez «Mise à jour de logiciels» dans l’Aide Mac. 
Â Pour obtenir les toutes dernières informations concernant Mac OS X, accédez au site 
web Mac OS X à l’adresse www.apple.com/fr/macosx.
Connexion à une imprimante
Suivez les instructions fournies avec votre imprimante pour installer les logiciels requis 
et connecter l’imprimante. Mac OS X intègre la plupart des gestionnaires d’imprimantes. 
Vous pouvez connecter la plupart des imprimantes au moyen d’un câble USB ; d’autres 
peuvent requérir une connexion en réseau, par exemple via Ethernet. Si vous possédez 
une borne d’accès AirPort Express ou AirPort Extreme, vous pouvez connecter une 
imprimante USB à la borne d’accès (plutôt qu’à l’ordinateur) pour effectuer des tâches 
d’impression sans fil. Pour en savoir plus sur les ports USB, consultez la section «Utilisation de périphériques USB (Universal Serial Bus)» à la page 58. Pour en savoir plus sur 
les connexions réseau ou sans fil, consultez la section «Fonctionnement de l’accès sans 
fil à Internet via AirPort» à la page 66 et «Connexion via Ethernet» à la page 69.
Lorsque vous connectez une imprimante USB, elle est normalement automatiquement 
détectée par votre ordinateur qui l’ajoute alors à la liste des imprimantes disponibles. 
Il se peut que vous ayez besoin du nom réseau ou de l’adresse des imprimantes connectées à un réseau pour pouvoir imprimer. Utilisez la fenêtre Imprimantes et fax des 
Préférences Système pour sélectionner votre imprimante.
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Remarque : si votre imprimante ne fonctionne pas, il sera peut-être nécessaire de consulter le site web de son fabricant pour obtenir le logiciel de gestionnaire d’imprimante 
compatible à installer.
Pour configurer une imprimante :
1 Ouvrez Préférences Système et cliquez sur l’icône Imprimantes et fax.
2 Cliquez sur Impression puis sur le bouton Ajouter (+) pour ajouter une imprimante.
3 Sélectionnez l’imprimante que vous souhaitez utiliser, puis cliquez sur Ajouter.
4 Utilisez les boutons Ajouter (+) et Supprimer (–) pour choisir les imprimantes que vous 
souhaitez voir apparaître dans la liste des imprimantes.
Contrôle de l’impression
Après avoir envoyé un document à une imprimante, vous pouvez contrôler l’impression, 
interrompre votre tâche d’impression ou la placer temporairement en attente. Cliquez 
sur l’icône Imprimante dans le Dock pour ouvrir la fenêtre Imprimante. Pour plus d’informations, choisissez Aide > Aide Mac et recherchez «impression».
Lecture d’un CD et connexion d’un casque d’écoute
Vous pouvez utiliser iTunes, un juke-box numérique et magasin facile à utiliser, d’où vous 
pouvez télécharger de la musique, des clips vidéos, des podcasts et des livres audio et 
écouter votre musique iTunes et des CD tout en utilisant votre ordinateur. Insérez un CD 
de musique dans votre lecteur optique et iTunes apparaîtra automatiquement à l’écran. 
Vous pouvez écouter de la musique soit via les haut-parleurs internes du MacBook, soit 
en branchant un casque d’écoute sur le port de sortie casque de votre MacBook. 
Pour en savoir plus sur iTunes :
m Ouvrez iTunes et choisissez Aide > Aide iTunes et Music Store. 
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Connexion d’un appareil photo ou de tout autre périphérique 
FireWire ou USB
Vous pouvez connecter un iPod, un appareil photo numérique, une caméra vidéo, un 
scanneur ou tout autre appareil doté d’un connecteur FireWire ou USB à votre MacBook. 
Suivez les instructions d’installation fournies avec votre appareil. Pour obtenir des informations sur FireWire, consultez la section «Connexion via FireWire» à la page 62. Pour 
obtenir des informations sur les connexions USB, consultez la section «Utilisation de périphériques USB (Universal Serial Bus)» à la page 58.
Transfert de fichiers depuis ou vers un autre ordinateur
Si vous souhaitez transférer des fichiers ou des documents depuis ou vers un autre 
ordinateur, vous pouvez procéder de différentes manières.
Â Vous pouvez facilement transférer tous vos fichiers à l’aide d’Assistant migration 
et d’un câble FireWire (vendu séparément). 
Â Vous pouvez également vous connecter à un autre Mac à l’aide d’un câble FireWire 
et démarrer votre MacBook en mode disque cible FireWire. Votre MacBook apparaît 
alors en tant que disque dur sur l’autre ordinateur et vous pouvez y faire glisser 
des fichiers. Pour plus d’informations sur l’utilisation de FireWire pour transférer des 
fichiers, consultez la section «Connexion de votre MacBook à un autre ordinateur via 
FireWire» à la page 64.
Â Si vous possédez un lecteur de disque dur externe, un iPod, un lecteur flash ou tout 
autre périphérique de stockage de données qui se connecte via un câble USB ou 
FireWire, vous pouvez l’utiliser pour transférer des fichiers. 
Â Si vous disposez d’un compte de messagerie, vous pouvez envoyer vos fichiers par 
courrier électronique vers un autre ordinateur.
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Â Si vous souscrivez un compte .Mac (payant) auprès d’Apple, vous pouvez l’utiliser 
pour transférer des fichiers. Avec un compte .Mac, vous obtenez un iDisk qui vous 
fournit un espace Internet pour la sauvegarde et le stockage de fichiers, afin que 
d’autres ordinateurs puissent accéder aux fichiers que vous y transférez. 
Â À l’aide d’un lecteur optique enregistrable, vous pouvez enregistrer des fichiers pour 
les transférer sur CD ou DVD.
Â Si vous connectez votre ordinateur à un réseau via Ethernet, vous pouvez échanger 
des fichiers avec d’autres ordinateurs du réseau. Vous pouvez accéder à un serveur 
ou à un autre ordinateur en cliquant sur Réseau dans la barre latérale du Finder ou 
en choisissant Aller > «Se connecter au serveur» dans la barre des menus du Finder.
Â Vous pouvez créer un petit réseau Ethernet en connectant un câble Ethernet depuis 
votre MacBook jusqu’au port Ethernet d’un autre ordinateur. Après vous être connecté 
à l’autre ordinateur, vous pouvez transférer des fichiers directement d’un ordinateur à 
l’autre. Pour plus d’informations, ouvrez l’Aide Mac et recherchez «Connexion de deux 
ordinateurs».
Â Vous pouvez vous connecter à un réseau sans fil AirPort Extreme pour transférer des 
fichiers. Pour plus d’informations, consultez la section «Fonctionnement de l’accès 
sans fil à Internet via AirPort» à la page 66.
Â Si vous avez accès à des appareils qui communiquent via la technologie sans fil 
Bluetooth®, vous pouvez transférer des fichiers vers d’autres appareils équipés de 
cette technologie. Pour plus d’informations, consultez la section «Utilisation de la 
technologie sans fil Bluetooth» à la page 67.
Pour obtenir des informations générales sur le transfert de fichiers et de documents, 
ouvrez l’Aide Mac et recherchez «transfert» ou le type de connexion dont vous avez besoin.
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3
3 Utilisation de votre MacBook
Votre MacBook comporte de nombreuses fonctions 
et capacités de connexion intégrées. 
En voici la liste :
Â des ports USB 2.0 (Universal Serial Bus) pour la connexion d’appareils, notamment 
iPod, imprimantes ou scanneurs (voir «Utilisation de périphériques USB (Universal 
Serial Bus)» à la page 58) ;
Â un port FireWire 400 pour connecter des périphériques à haute vitesse, tels que 
caméras vidéo numériques et disques durs externes (voir «Connexion via FireWire» à 
la page 62) ;
Â la connectivité sans fil Bluetooth, la capacité réseau sans fil AirPort Extreme et la capacité réseau Ethernet Gigabit. (voir «Fonctionnement de l’accès sans fil à Internet via 
AirPort» à la page 66 et «Connexion via Ethernet» à la page 69) ;
Â un port d’entrée de ligne audio/audio numérique optique et un port de sortie casque/
audio numérique optique pour connecter un casque, des haut-parleurs et des appareils 
audio numériques (voir «Connexion de haut-parleurs et autres périphériques audio» à la 
page 75) ;
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Â un port vidéo mini-DVI pour connecter votre MacBook à un moniteur externe via un 
adaptateur Mini-DVI vers DVI ou Mini-DVI vers VGA : utilisez un adaptateur Mini-DVI 
vers Vidéo pour connecter tout appareil vidéo nécessitant une connexion composite 
ou S-Vidéo ; tous les adaptateurs sont vendus séparément (voir «Gestion de la vidéo 
externe» à la page 71) ;
Â un lecteur optique à chargement par fente pour la lecture de CD et de DVD et pour 
la gravure de CD ; si vous disposez d’un lecteur SuperDrive, vous pouvez également 
graver des DVD (voir «Utilisation du lecteur optique» à la page 76) ;
Â la technologie Sudden Motion Sensor qui contribue à protéger le disque dur en cas 
de chute ou de vibrations subies par votre MacBook (voir «Technologie 
Sudden Motion Sensor» à la page 81) ;
Â une batterie MacBook dont vous pouvez facilement consulter l’état de charge 
(voir «Utilisation de la batterie» à la page 81) ;
Â un logement de sécurité pour éviter que votre MacBook ne disparaisse (voir «Protection 
de votre MacBook» à la page 87).
Utilisation de périphériques USB (Universal Serial Bus)
Votre MacBook est livré avec deux ports USB 2.0 (d), ou ports USB haute vitesse, à utiliser 
pour connecter de nombreux périphériques externes, notamment iPod, imprimantes, scanneurs, appareils photo numériques, manettes de jeu, claviers ou lecteurs de disquette. 
Ces ports USB 2.0 sont compatibles avec les anciens modèles de périphériques USB. Vous 
pouvez, dans la plupart des cas connecter et déconnecter un périphérique USB pendant 
que l’ordinateur est allumé. Vous pouvez utiliser les périphériques dès leur branchement. 
Il n’est pas nécessaire de redémarrer ni de reconfigurer votre ordinateur.
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Pour utiliser un périphérique USB avec votre ordinateur, connectez-le. Votre ordinateur 
détecte automatiquement tout nouveau périphérique connecté et ouvre le logiciel 
adéquat. 
Remarque : si vous avez connecté un périphérique USB et que votre MacBook ne 
trouve pas le gestionnaire approprié, vous pouvez installer le gestionnaire fourni avec 
le périphérique ou consulter le site web du fabricant du périphérique afin de trouver 
et installer le gestionnaire approprié.
Périphériques USB et énergie de la batterie
Vous pouvez utiliser des périphériques USB, tels qu’une manette de jeu ou un clavier, qui 
sont alimentés via le port USB de votre MacBook plutôt que via un adaptateur secteur 
distinct. Ce type de périphérique USB peut toutefois provoquer un déchargement plus 
rapide de la batterie du MacBook. Si vous comptez connecter le périphérique pendant 
une longue période, il est recommandé de brancher le MacBook à son adaptateur secteur.
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Utilisation simultanée de plusieurs périphériques USB
Vous pouvez vous procurer un concentrateur USB pour connecter plusieurs périphériques USB à votre ordinateur. Vous pouvez connecter le concentrateur à un port USB 
disponible de votre ordinateur pour disposer de ports USB supplémentaires (en général 
quatre ou sept). Les concentrateurs haute vitesse prennent en charge les périphériques 
USB 2.0 haute vitesse, ainsi que les périphériques compatibles USB 1.1. Les concentrateurs 
USB 1.1 ne permettent pas aux périphériques USB haute vitesse de fonctionner à leur 
vitesse maximale. La plupart des concentrateurs USB disposent d’un adaptateur secteur 
et doivent être branchés sur une prise secteur.
Remarque : si vous utilisez une chaîne de périphériques et de concentrateurs USB, certains d’entre eux risquent de ne pas fonctionner s’ils sont connectés via une combinaison 
de concentrateurs USB 2.0 haute vitesse et de concentrateurs USB 1.1 à vitesse normale 
ou faible. Il se peut, par exemple, qu’aucun disque dur externe USB ne s’affiche sur votre 
bureau. Pour éviter ce problème, ne connectez pas ensemble des périphériques USB pré-
sentant des vitesses différentes. Connectez directement votre concentrateur à haut débit à 
votre ordinateur, puis connectez-y des périphériques à haut débit. Connectez directement 
un concentrateur à vitesse normale ou faible à votre ordinateur, puis connectez-y des 
périphériques de vitesse similaire.
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Pour en savoir plus à propos de la technologie USB
L’Aide Mac contient des informations supplémentaires sur la technologie USB. Choisissez 
Aide > Aide Mac dans la barre des menus et recherchez «USB». Vous trouverez d’autres 
informations sur le site web USB d’Apple, à l’adresse www.apple.com/fr/usb. Pour obtenir 
des informations sur les périphériques USB disponibles pour votre ordinateur, consultez 
le Guide des Produits Macintosh à l’adresse www.apple.com/fr/guide.
Concentrateur USB
F3626M42.book Page 61 Wednesday, April 5, 2006 2:17 PM62 Chapitre 3 Utilisation de votre MacBook
Connexion via FireWire
Votre ordinateur est équipé d’un port FireWire 400 (H). La technologie FireWire vous 
permet de connecter et de déconnecter aisément des périphériques haute vitesse, 
tels que des caméras haute définition HDV ou numériques DV et des disques durs, 
sans redémarrer votre ordinateur. 
Vous pouvez connecter un périphérique FireWire standard à 6 broches directement 
au port FireWire 400 (H). Le port fournit en alimentation les périphériques connectés 
(ces derniers n’ont donc pas besoin de prise d’alimentation séparée). 
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La technologie FireWire vous permet notamment de :
Â connecter une caméra HDV ou DV pour capturer, transférer et faire des montages 
vidéo de grande qualité directement sur votre ordinateur au moyen de logiciels 
de montage vidéo tels qu’iMovie HD, Final Cut Express ou Final Cut Studio (vendus 
séparément) ;
Â connecter un disque dur FireWire externe et l’utiliser pour sauvegarder des données 
ou transférer des fichiers ; 
Â démarrer à partir d’un disque dur externe FireWire : connectez un disque dur FireWire 
externe (doté de Mac OS X version 10.4.6 ou ultérieure), ouvrez la fenêtre Démarrage 
des Préférences Système, puis cliquez sur l’icône de disque dur FireWire et redémarrez 
votre ordinateur) ;
Â transférer des fichiers entre votre MacBook et un autre ordinateur FireWire via le mode 
disque cible FireWire : pour toute information supplémentaire, consultez la section 
«Connexion de votre MacBook à un autre ordinateur via FireWire» à la page 64.
Utilisation de périphériques FireWire
Pour utiliser un périphérique FireWire avec votre ordinateur, connectez-le à l’ordinateur 
et installez tout logiciel fourni avec le périphérique en question. Votre ordinateur détecte 
automatiquement les nouveaux périphériques connectés.
Remarque : si vous avez connecté un périphérique FireWire et que votre MacBook ne 
trouve pas le gestionnaire approprié, vous pouvez installer le gestionnaire fourni avec 
le périphérique ou consulter le site web du fabricant du périphérique afin de trouver 
et installer le gestionnaire approprié.
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Périphériques FireWire et énergie de la batterie
Vous pouvez utiliser des périphériques FireWire (comme certains disques durs externes) 
alimentés par la connexion FireWire du MacBook plutôt que par un adaptateur secteur 
séparé. Ce type de périphérique FireWire peut toutefois provoquer un déchargement 
plus rapide de la batterie du MacBook. Si vous comptez connecter un périphérique 
pendant une longue période, il est recommandé de brancher le MacBook sur son adaptateur secteur.
Remarque : le port FireWire (H) est conçu pour prendre en charge l’alimentation des 
périphériques FireWire (7 watts maximum). Il est possible de connecter plusieurs périphériques entre eux, puis de connecter cette chaîne de périphériques au port FireWire 
de votre ordinateur, à condition que seul l’un d’eux soit alimenté directement par 
l’ordinateur. Les autres périphériques de la chaîne doivent alors être alimentés par 
des adaptateurs secteur distincts. La connexion de plusieurs périphériques FireWire 
alimentés par le port peut poser des problèmes. En cas de problème, éteignez l’ordinateur, déconnectez les périphériques FireWire, puis redémarrez l’ordinateur.
Connexion de votre MacBook à un autre ordinateur via FireWire
Si vous souhaitez transférer des fichiers de votre MacBook à un autre ordinateur Macintosh 
équipé de la technologie FireWire ou que vous êtes confronté à un problème qui empêche 
le démarrage de votre ordinateur, utilisez le mode disque cible FireWire pour vous connecter à l’autre ordinateur. Lorsque vous démarrez votre ordinateur en mode disque cible 
FireWire, l’autre ordinateur peut accéder à votre MacBook comme s’il s’agissait d’un disque 
dur externe.
Remarque : lorsque vous utilisez le mode disque cible FireWire, il est conseillé de 
connecter l’adaptateur secteur à votre MacBook.
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Pour connecter votre MacBook avec un autre ordinateur en mode disque cible 
FireWire :
1 Assurez-vous que votre MacBook est éteint.
2 Utilisez un câble FireWire pour connecter votre MacBook à un autre ordinateur équipé 
de FireWire. 
3 Démarrez votre MacBook, puis maintenez immédiatement la touche T enfoncée. 
L’écran de votre MacBook affiche alors le logo FireWire. L’écran de l’autre ordinateur 
affiche l’icône du disque dur interne de votre MacBook. Vous pouvez maintenant 
glisser-déposer des fichiers entre les deux ordinateurs.
4 Une fois que vous avez terminé de transférer les fichiers, faites glissez l’icône du disque 
dur du MacBook dans la corbeille (icône d’éjection).
5 Appuyez sur le bouton d’alimentation (®) de votre MacBook pour l’éteindre, puis 
débranchez le câble FireWire.
Pour en savoir plus à propos de FireWire
L’Aide Mac fournit des informations supplémentaires sur FireWire. Choisissez Aide > 
Aide Mac dans la barre des menus du Finder et cherchez «FireWire». Vous 
trouverez d’autres informations sur le site web FireWire d’Apple, à l’adresse 
www.apple.com/fr/firewire.
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Fonctionnement de l’accès sans fil à Internet via AirPort
Grâce à la technologie AirPort Extreme, votre MacBook établit une connexion sans fil 
à une borne d’accès AirPort Express ou AirPort Extreme ou à tout produit compatible 
802.11b ou 802.11g, qui est connecté à Internet via une ligne téléphonique, un modem 
DSL ou câble ou un réseau local (LAN).
Pour en savoir plus sur AirPort Extreme
Pour acheter une borne d’accès AirPort Extreme ou AirPort Express, accédez à 
l’Apple Store en ligne, à l’adresse www.apple.com/francestore ou adressez-vous 
à votre revendeur agréé Apple.
Connexion
à Internet
AirPort Express Prise secteur
Modem câble ou DSL
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Des informations complémentaires sur AirPort Extreme et AirPort Express sont disponibles 
dans l’Aide AirPort. Sélectionnez Aide > Aide Mac, puis Centre d’aide > Aide AirPort. Des 
informations supplémentaires sont disponibles sur le site AirPort d’Apple aux pages 
www.apple.com/fr/airportexpress et www.apple.com/fr/airportextreme.
Utilisation de la technologie sans fil Bluetooth
La technologie sans fil Bluetooth est intégrée à votre MacBook. Elle vous permet d’établir des connexions sans fil de faible portée entre ordinateurs de bureau ou portables, 
assistants personnels (PDA), téléphones portables, téléphones appareils photo, imprimantes, appareils photo numériques et périphériques sans fil tels que le clavier 
Apple Wireless Keyboard ou la souris Apple Wireless Mouse (disponibles sur l’Apple Store 
en ligne à l’adresse www.apple.com/francestore). 
La technologie sans fil Bluetooth permet d’éliminer les câbles reliant normalement 
les périphériques. Les périphériques équipés de la technologie Bluetooth peuvent 
se connecter l’un à l’autre sans besoin de liaison physique, dans la mesure où ils sont 
séparés d’une distance égale ou inférieure à 10 mètres.
Grâce à la technologie sans fil Bluetooth, vous pouvez :
Â utiliser votre MacBook pour communiquer avec un téléphone portable compatible 
Bluetooth : votre téléphone peut servir de modem pour vous connecter à un fournisseur d’accès sans fil, à un débit égal ou inférieur à 56 kilobits par seconde (kbps), 
suffisant pour vous connecter à Internet ;
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Â synchroniser votre ordinateur avec votre organiseur de poche équipé de la technologie 
Bluetooth : à l’aide d’iSync, vous pouvez exécuter une opération HotSync sans fil ou 
transmettre votre carte de visite ou encore des événements de calendrier directement 
sur le PDA d’un collègue ;
Â échanger des fichiers entre ordinateurs et périphériques équipés de la technologie 
Bluetooth, même entre Mac et PC ;
Â utiliser une imprimante, un clavier, une souris ou un casque d’écoute sans fil Bluetooth.
Configuration d’un périphérique Bluetooth
Avant de pouvoir utiliser un périphérique Bluetooth avec votre MacBook, vous devez 
configurer le périphérique de manière à ce qu’il puisse fonctionner avec votre ordinateur. Une fois que vous avez configuré le périphérique, celui-ci est jumelé avec votre 
ordinateur et apparaît dans la fenêtre Périphériques des Préférences Bluetooth. Le 
jumelage du périphérique avec votre ordinateur ne doit être effectué qu’une seule fois. 
Il demeure activé aussi longtemps que vous ne le supprimer pas de manière explicite.
Pour configurer un périphérique Bluetooth :
1 Choisissez Configurer l’appareil Bluetooth dans le menu d’état Bluetooth (◊).
2 Suivez les instructions affichées à l’écran pour le type de périphérique que vous 
souhaitez configurer.
Si le menu d’état Bluetooth (◊) n’apparaît pas dans la barre des menus, ouvrez 
Préférences Système et cliquez sur Bluetooth. Cliquez sur Réglages, puis sélectionnez 
«Afficher l’état Bluetooth dans la barre des menus».
Pour supprimer un jumelage avec un autre périphérique :
1 Ouvrez Préférences Système, puis cliquez sur Bluetooth. 
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2 Cliquez sur Périphériques et choisissez le périphérique dans la liste. 
3 Cliquez sur Supprimer.
Pour en savoir plus sur la technologie sans fil Bluetooth
Pour plus d’informations sur Bluetooth, ouvrez l’application Échange de fichiers Bluetooth 
(dans le dossier Utilitaires du dossier Applications) et sélectionnez Aide > Aide Bluetooth. 
Vous trouverez d’autres informations sur le site web Bluetooth d’Apple, à l’adresse 
www.apple.com/fr/bluetooth.
Connexion via Ethernet
Votre ordinateur est fourni avec des capacités de mise en réseau Ethernet Gigabit (G) 
intégrées, qui permettent de vous connecter à un réseau, à un modem DSL ou à un 
modem câble. 
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La connexion à un réseau permet d’accéder à d’autres ordinateurs et potentiellement 
à des imprimantes réseau, des modems, le courrier électronique et Internet. Vous pouvez utiliser Ethernet pour partager des fichiers entre deux ordinateurs ou établir un 
petit réseau. Le port Ethernet de votre MacBook détecte automatiquement les autres 
périphériques Ethernet. Pour établir des connexions à d’autres périphériques Ethernet, 
il est inutile d’utiliser un câble croisé Ethernet.
Pour en savoir plus sur l’utilisation d’Ethernet
Des informations supplémentaires, y compris sur la configuration d’un réseau Ethernet et 
le transfert de fichiers via Ethernet, sont disponibles dans l’Aide Mac. Choisissez Aide > 
Aide Mac, puis recherchez «Ethernet» ou «réseau». 
Pour obtenir des informations sur les produits de mise en réseau que vous pouvez 
utiliser avec votre MacBook, consultez le Guide des produits Macintosh à l’adresse 
www.apple.com/fr/guide/.
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Gestion de la vidéo externe 
Votre ordinateur est équipé d’un port de moniteur externe (mini DVI) permettant une connexion directe à un écran ou à un projecteur muni d’un port DVI ou VGA. Utilisez l’adaptateur Mini-DVI vers DVI d’Apple (vendu séparément) pour connecter votre MacBook à un 
moniteur ou projecteur DVI. Utilisez l’adaptateur Mini-DVI vers VGA d’Apple (vendu séparément) pour connecter votre MacBook à un moniteur ou projecteur VGA.
Vous pouvez également afficher des images sur un téléviseur, enregistrer des images 
numériques sur un magnétoscope ou lire des DVD sur votre téléviseur à l’aide d’un adaptateur Mini-DVI vers Vidéo d’Apple à utiliser avec des connecteurs composite ou S-Vidéo. 
Vous pouvez vous procurer les adaptateurs chez un revendeur agréé Apple, dans un 
magasin Apple Store ou sur l’Apple Store en ligne à l’adresse www.apple.com/francestore.
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Lorsqu’un moniteur externe ou un téléviseur est connecté, vous pouvez soit faire en 
sorte que la même image s’affiche sur l’écran intégré et le moniteur externe (c’est ce 
que l’on appelle la recopie vidéo), soit utiliser le moniteur externe pour étendre la taille 
du bureau Mac OS (on parle dans ce cas de mode double-écran ou de bureau étendu). 
Par défaut, votre MacBook démarre en mode double-écran. Appuyez sur la touche F7 (i) 
pour alterner entre les modes double-écran et recopie vidéo.
Si vous souhaitez que le son soit émis par un écran externe (un projecteur ou un téléviseur, par exemple), vous devez relier le port de sortie casque (f) de l’ordinateur à ce 
périphérique via un câble audio (non inclus).
Remarque : en raison des limites d’affichage de la plupart des téléviseurs, les images 
apparaissent avec une qualité inférieure à celle de l’écran intégré ou du moniteur externe.
Connexion d’un écran externe ou d’un projecteur
Pour connecter à votre ordinateur un écran externe ou un projecteur via un 
connecteur DVI ou VGA :
1 Allumez l’écran externe ou le projecteur.
2 Vérifiez que le câble de l’écran est bien relié au projecteur ou à l’écran externe.
3 Connectez le câble de l’écran à votre MacBook à l’aide de l’adaptateur adéquat 
(adaptateur Mini-DVI vers DVI ou Mini-DVI vers VGA d’Apple). Votre MacBook détecte 
automatiquement l’écran externe ou le projecteur.
4 Réglez la résolution d’un écran externe via la fenêtre Moniteurs des 
Préférences Système ou l’icône Moniteurs de la barre de menus.
Remarque : votre MacBook gère les résolutions de moniteurs externes jusqu’à 
1920 x 1200 (moniteurs DVI d’Apple) ou 1600 x 1200 (moniteurs VGA).
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Utilisation de votre MacBook écran rabattu
Vous pouvez utiliser votre MacBook en gardant l’écran rabattu si l’ordinateur est 
connecté à un moniteur, un clavier et une souris externes. 
Important : pour utiliser votre MacBook écran rabattu, branchez-le sur une prise secteur.
Pour utiliser votre ordinateur écran rabattu avec un moniteur externe connecté :
1 Connectez un clavier et une souris USB à votre MacBook.
2 Connectez l’adaptateur secteur à votre MacBook et à une prise secteur. Vérifiez que 
la lampe de l’adaptateur secteur est allumée.
3 Rabattez l’écran du MacBook afin d’en suspendre l’activité.
4 Connectez votre MacBook à un écran externe en suivant les étapes décrites dans 
la section précédente.
5 Attendez quelques secondes, puis appuyez sur n’importe quelle touche du clavier 
externe pour réactiver le MacBook.
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Connexion d’un téléviseur, d’un magnétoscope ou de tout autre 
appareil vidéo
Pour connecter un téléviseur ou tout autre appareil vidéo nécessitant une connexion 
composite ou S-Vidéo :
1 Connectez l’adaptateur Mini-DVI vers vidéo d’Apple (vendu séparément) au port 
Mini-DVI de votre MacBook.
2 Connectez le périphérique à l’adaptateur.
3 Si vous souhaitez que le son de votre MacBook soit restitué sur le périphérique, 
connectez le port de sortie casque (f) de votre MacBook aux ports d’entrée audio 
du périphérique via un câble mini-jack vers RCA (non inclus).
4 Allumez l’appareil.
5 Pour détecter le téléviseur ou tout autre périphérique externe, maintenez la touche 
Commande (x) enfoncée et appuyez sur la touche F2. Vous pouvez également ouvrir 
la fenêtre Moniteurs des Préférences Système et cliquez sur le bouton Détecter les 
moniteurs.
6 Pour régler l’apparence de l’image affichée à l’écran, ouvrez la fenêtre Moniteurs des 
Préférences Système.
Pour en savoir plus sur l’utilisation d’un moniteur externe ou d’un 
téléviseur
Vous pourrez trouver des informations supplémentaires sur la configuration et l’utilisation 
d’un moniteur externe dans l’Aide Mac. Choisissez Aide > Aide Mac dans la barre des 
menus, puis recherchez «moniteur externe». 
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Connexion de haut-parleurs et autres périphériques audio
Votre MacBook est équipé de trois haut-parleurs intégrés, d’un microphone intégré, 
d’un port d’entrée ligne audio/audio numérique optique et d’un port de sortie casque/
audio numérique optique (f). 
Vous pouvez connecter des haut-parleurs externes, des écouteurs et d’autres périphériques de sortie audio au port de sortie casque (f). Ce port de sortie constitue également 
une prise mini-phono stéréo S/PDIF de 3,5 mm. Les haut-parleurs intégrés n’émettent 
aucun son lorsque des périphériques sont branchés sur l’ordinateur. Pour que le son soit 
émis de ces haut-parleurs, débranchez le casque ou les haut-parleurs externes éventuellement connectés à l’ordinateur.
Vous pouvez enregistrer des sons sur votre disque dur à l’aide du micro intégré situé à 
côté de la caméra iSight intégrée. Vous avez également la possibilité de connecter des 
micros externes ou tout autre appareil audio sur le port d’entrée de ligne audio. Le port 
d’entrée de ligne audio constitue également une prise mini-phono stéréo S/PDIF de 
3,5 mm. Étant donné que cette prise ne permet pas d’alimenter les périphériques 
connectés, ces derniers doivent être auto-alimentés. Si vous disposez d’un adaptateur 
Toslink prise vers mini-jack, vous pouvez utiliser un câble Toslink pour connecter un 
lecteur Digital Audio Tape (DAT) ou des instruments numériques afin d’enregistrer et 
de mixer votre propre musique.
Pour les applications capables d’enregistrement audio, telles qu’iMovie HD, utilisez 
la fenêtre Son des Préférences Système pour sélectionner le périphérique d’entrée 
audio à utiliser (y compris des micros connectés via USB). 
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Les commandes de volume de votre clavier vous permettent de régler facilement le 
volume de sortie. Vous pouvez également régler le volume d’entrée et de sortie dans 
la fenêtre Son des Préférences Système.
Pour plus d’informations sur l’utilisation ou le dépannage du son de votre ordinateur, 
choisissez Aide > Aide Mac, puis effectuez une recherche à l’aide du mot son.
Utilisation du lecteur optique
Votre MacBook comprend un lecteur optique, Combo ou SuperDrive. 
Avec votre lecteur optique, vous pouvez :
Â installer ou utiliser des logiciels à partir de CD et de DVD ;
Â lire de la musique et des fichiers multimédia à partir de CD ;
Â écrire des fichiers musicaux, des documents et d’autres fichiers numériques sur CD-R 
ou CD-RW ;
Â lire des films DVD ainsi que la plupart des disques DVD.
Si vous disposez d’un lecteur SuperDrive, vous pouvez également enregistrer des 
données sur des disques DVD±R ou DVD±RW vierges.
Important : le lecteur optique de votre MacBook gère les disques standard circulaires de 
12 cm de diamètre. Les disques de forme irrégulière et les disques de moins de 12 cm ne 
peuvent pas être lus. Les disques de ce type risquent de se bloquer dans le lecteur.
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Insertion d’un CD ou DVD
Pour installer ou utiliser des logiciels à partir d’un CD ou d’un DVD :
1 L’ordinateur étant allumé, introduisez le disque (étiquette vers le haut) dans la fente du 
lecteur jusqu’à ce que le lecteur le saisisse. 
Il se peut qu’il faille insérer le disque presque entièrement avant que cela ne se produise. 
Cela est normal.
2 Dès que son icône apparaît sur le bureau, le disque peut être utilisé.
Éjection d’un disque
Pour éjecter un disque, procédez comme suit :
Â Glissez l’icône du disque dans la Corbeille (icône d’éjection).
Â Maintenez enfoncée la touche d’éjection de disque (C) du clavier jusqu’à ce que 
le disque soit éjecté.
Attendez que le disque soit complètement éjecté avant de le retirer ou de le réinsérer.
®?
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Si vous ne parvenez pas à éjecter le disque, fermez toutes les applications susceptibles 
d’utiliser le disque et réessayez. Si cela ne donne pas de résultats, redémarrez l’ordinateur tout en maintenant le bouton du trackpad enfoncé.
Lecture de DVD
Pour lire un disque vidéo DVD sur votre MacBook, insérez le DVD. Lecteur DVD s’ouvre 
automatiquement. Vous pouvez constater que Lecteur DVD offre des commandes 
simples d’utilisation pour lancer, interrompre et visionner les DVD.
Si vous avez connecté votre MacBook à un téléviseur afin de pouvoir regarder le DVD 
sur l’écran du téléviseur, sélectionnez 720 x 480 NTSC (aux États-Unis) ou 720 x 576 PAL 
(en Europe et dans d’autres régions) dans la fenêtre Moniteurs des Préférences Système. 
Il est très facile de connecter votre MacBook à une chaîne stéréo. Utilisez un câble 
mini-jack vers RCA (non inclus) pour relier le port de sortie casque (f) de votre 
MacBook aux ports d’entrée audio de votre chaîne stéréo.
Enregistrement de disques CD-R ou CD-RW
Votre MacBook peut enregistrer des données sur des disques CD-R ou CD-RW. Si vous 
disposez d’un lecteur SuperDrive, vous pouvez également enregistrer vos propres films 
numériques sur des disques DVD±R ou DVD±RW enregistrables vierges. Vous pouvez 
également enregistrer d’autres types de données numériques, telles que des sauvegardes 
de fichiers, sur un DVD enregistrable.
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Pour enregistrer des données sur des disques CD-R, CD-RW, DVD±R ou DVD+RW :
1 Insérez un disque CD ou DVD (SuperDrive seulement) enregistrable vierge dans 
le lecteur optique.
2 Dans la zone de dialogue qui apparaît, attribuez un nom au disque et sélectionnez 
le format que vous souhaitez utiliser.
3 Double-cliquez sur l’icône du disque qui apparaît sur votre bureau, puis faites-y glisser 
des fichiers et des dossiers.
4 Cliquez sur l’icône Graver le disque située à côté du nom du disque dans la barre latérale 
du Finder.
Vous pouvez également enregistrer de la musique sur des disques CD ou DVD 
directement à partir de votre bibliothèque iTunes.
Pour enregistrer de la musique depuis votre bibliothèque iTunes :
1 Cliquez sur l’icône iTunes dans le Dock.
2 Sélectionnez la liste de lecture ou les morceaux à enregistrer.
3 Insérez un disque CD ou DVD (SuperDrive seulement) vierge.
4 En haut de la fenêtre iTunes, cliquez sur l’option Graver le CD.
Important : si votre batterie se décharge lors de la gravure d’un CD, il se peut que 
la gravure échoue et que le CD devienne inutilisable. Pour éviter cela, utilisez toujours 
votre adaptateur secteur lorsque vous gravez un CD.
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Si vous disposez d’un lecteur SuperDrive, vous pouvez enregistrer vos films numériques sur des disques DVD enregistrables vierges. Vous pouvez également enregistrer 
d’autres types de données numériques. Vous pouvez, par exemple, sauvegarder des 
fichiers sur des DVD enregistrables. Les applications telles qu’iDVD vous permettent de 
créer vos propres projets multimédias numériques, de les graver sur des disques DVD 
enregistrables vierges, puis de les lire sur la plupart des lecteurs DVD standard.
Pour graver un projet iDVD sur un disque vierge DVD±R ou DVD±RW :
1 Ouvrez iDVD puis votre projet iDVD.
2 Cliquez sur le bouton Graver.
3 À l’invite, insérez un disque DVD enregistrable vierge dans le lecteur.
4 Cliquez de nouveau sur le bouton Graver.
Pour en savoir plus, ouvrez iDVD puis choisissez Aide > Aide iDVD.
Important : si votre batterie se décharge lors de la gravure d’un DVD, il se peut que la 
gravure échoue et que le DVD devienne inutilisable. Pour éviter cela, utilisez toujours 
votre adaptateur secteur lorsque vous gravez un DVD.
Pour en savoir plus
Pour obtenir davantage d’informations sur Lecteur DVD et iTunes, consultez les sources 
suivantes :
Â Pour plus d’informations sur l’utilisation de l’application Lecteur DVD, choisissez 
Aide > Aide Lecteur DVD au sein de Lecteur DVD.
Â Pour obtenir des informations sur la manière d’utiliser iTunes afin d’enregistrer des 
fichiers de musique sur disque CD ou DVD, choisissez Aide > «Aide iTunes et Music Store» 
dans l’application iTunes.
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Technologie Sudden Motion Sensor
Votre MacBook utilise la technologie Sudden Motion Sensor qui contribue à protéger le 
disque dur contre tout dommage en cas de chute ou de vibrations subies par l’ordinateur.
En règle générale, la protection Sudden Motion Sensor ne modifie en rien les performances du disque dur au cours du fonctionnement normal du MacBook. Il peut arriver 
que des vibrations anormalement fortes activent le capteur Sudden Motion Sensor 
pendant que votre MacBook est en cours d’écriture ou de lecture intense (comme lors 
de la lecture ou de l’enregistrement vidéo ou audio). Si vous constatez des pertes 
d’images ou d’éléments sonores, assurez-vous que votre MacBook se trouve dans un 
environnement stable protégé contre les vibrations et les mouvements brusques.
Utilisation de la batterie 
Lorsque l’adaptateur secteur externe n’est pas connecté, votre ordinateur est alimenté 
par sa batterie. L’autonomie de votre MacBook varie en fonction des applications utilisées et des périphériques externes connectés. La désactivation de fonctions telles 
qu’AirPort Extreme ou Bluetooth contribue à économiser l’énergie de votre batterie. 
Pour plus d’informations sur l’utilisation de la batterie, lisez la section «Conseils pour 
économiser la batterie» à la page 85.
Pour connaître le niveau de charge de votre batterie, vous pouvez observer les lampes 
témoins de niveau de charge dont elle est dotée. Appuyez sur le bouton situé en regard 
des témoin lumineux afin que ces derniers brillent brièvement pour indiquer le niveau 
de charge de la batterie. Vous pouvez vérifier le niveau de charge, que la batterie soit ou 
non insérée dans votre MacBook.
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Si votre batterie faiblit pendant que vous travaillez, branchez l’adaptateur secteur et 
laissez la batterie se recharger. Pour remplacer une batterie presque déchargée par une 
batterie chargée lorsque votre ordinateur n’est pas connecté à un adaptateur secteur, 
éteignez l’ordinateur. 
Important : si un seul témoin est allumé, le niveau restant est très faible. Si aucun témoin 
n’est allumé, c’est que la batterie est complètement vide et que l’ordinateur ne pourra 
démarrer sans l’adaptateur secteur. Branchez l’adaptateur secteur et laissez la batterie 
se recharger ou remplacez la batterie à plat par une batterie complètement rechargée 
(voir «retrait de la batterie» à la page 90).
Batterie
Témoins LED 
de la batterie
Bouton
¥
Á
F3626M42.book Page 82 Wednesday, April 5, 2006 2:17 PMChapitre 3 Utilisation de votre MacBook 83
Si l’icône de la batterie (dans la barre des menus du Finder) est réglée pour afficher 
le pourcentage de charge, vous constaterez parfois que la batterie n’indique pas un 
niveau de charge de 100 pour cent alors que l’adaptateur secteur est branché. Cela 
est tout à fait normal : le niveau de la batterie est maximisé lorsque le chargement n’est 
pas continu, et cette fonction est désactivée lorsque la capacité de charge de la batterie 
est située entre 95 et 100 pour cent. Dès que le niveau de la batterie passe en dessous 
de 95 pour cent, elle est automatiquement rechargée jusqu’à 100 pour cent. 
Retrait et remise en place de la batterie
Pour obtenir des instructions sur le retrait et la remise en place de la batterie, consultez 
les sections «retrait de la batterie» à la page 90 et «remplacement de la batterie» à la 
page 96.
Remarque : jetez vos batteries usagées en respectant les lois et les consignes environnementales locales. Pour plus d’informations, consultez la section «Informations sur l’enlèvement de la batterie» à la page 142.
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Recharge d’une batterie
Lorsque l’adaptateur secteur est connecté à votre ordinateur, la batterie se recharge, 
que l’ordinateur soit éteint, allumé ou en mode de suspension d’activité. La recharge 
sera toutefois plus rapide si l’ordinateur est éteint ou en mode de suspension d’activité. Lorsque l’ordinateur est allumé, vous pouvez contrôler le niveau de charge de 
la batterie au moyen de l’icône d’état Batterie dans la barre des menus.
Le niveau affiché dépend de la quantité d’énergie restant dans la batterie, mais aussi 
des applications et des périphériques en cours d’utilisation, ainsi que des réglages de 
votre système (luminosité de l’écran, réglages d’Économiseur d’énergie, etc.). Pour 
disposer de plus d’énergie, fermez des applications, déconnectez les périphériques 
non utilisés et réglez Économiseur d’énergie (voir section suivante).
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Conseils pour économiser la batterie
L’autonomie assurée par la batterie de votre MacBook avant qu’il soit nécessaire de la 
recharger dépend des applications et des périphériques utilisés, ainsi que des mesures 
prises pour économiser l’énergie.
Pour économiser l’énergie de la batterie, procédez comme suit :
Â Déconnectez les périphériques USB ou FireWire alimentés par bus lorsqu’ils ne sont 
pas utilisés.
Â Quittez les applications ouvertes non utilisées.
Â Désactivez AirPort et Bluetooth quand vous ne les utilisez pas : utilisez les icônes 
d’état AirPort et Bluetooth dans la barre des menus. Si ces icônes n’apparaissent 
pas dans la barre des menus, vous pouvez les activer dans les fenêtres Réseau et 
Bluetooth des Préférences Système. 
Â Éjectez les CD ou DVD non utilisés.
Â Réduisez la luminosité de l’écran à l’aide des boutons de réglage de luminosité situés 
sur le clavier du MacBook.
Â Réglez le disque dur afin qu’il réduise sa vitesse de rotation après un bref délai. 
Dans la fenêtre Économiseur d’énergie des Préférences Système, sélectionnez 
l’option «Suspendre l’activité du/des disque(s) dur(s) chaque fois que possible». 
Â Réglez votre MacBook afin qu’il suspende son activité après un maximum de 
cinq minutes.
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Â Votre MacBook est préréglé pour réduire automatiquement sa vitesse de traitement 
durant les périodes de faible activité, lorsqu’il est alimenté via la batterie, afin d’économiser de l’énergie. Vous pouvez déterminez cela via l’option Normal du menu local 
Optimisation des réglages (situé dans la fenêtre Économiseur d’énergie des 
Préférences Système). Pendant les périodes de grande activité, votre ordinateur passera automatiquement à une vitesse de traitement plus élevée. Pour prolonger au 
maximum la durée de vie de la batterie, choisissez «Meilleure autonomie de la batterie» 
dans le menu local Optimisation des réglages. Cette option risque toutefois de diminuer les performances de votre ordinateur. Pour régler votre ordinateur afin qu’il utilise 
sa vitesse de traitement maximale en permanence, choisissez Meilleures performances.
Informations supplémentaires concernant la batterie de 
votre MacBook
De plus amples informations sont disponibles dans l’Aide Mac. Choisissez Aide > Aide Mac, 
puis effectuez une recherche sur le terme «batterie». Vous trouverez également des 
informations sur la manière de prolonger la durée de vie de votre batterie sur le site 
www.apple.com/fr/batteries/notebooks.html.
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Protection de votre MacBook
Vous pouvez vous procurer un câble de sécurité pour protéger votre MacBook. 
Ce câble vous permet d’attacher votre ordinateur à un bureau ou une table. 
Pour en savoir plus sur les options de sécurité
L’Aide Mac contient des informations supplémentaires concernant les fonctions de 
sécurité logicielles de votre MacBook, y compris les mots de passe pour plusieurs 
utilisateurs et le chiffrement de fichiers. Choisissez Aide > Aide Mac, puis effectuez 
une recherche sur les termes «sécurité» ou «utilisateurs multiples».
Dispositif de 
verrouillage
avec câble 
de sécurité
Logement 
de sécurité
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4
4 Ajout de mémoire à 
votre MacBook
Ce chapitre fournit des informations et des instructions pour installer de la mémoire supplémentaire 
et pour retirer et remettre en place la batterie de 
votre MacBook. 
Votre ordinateur est doté de deux logements de mémoire auxquels vous pouvez accéder 
en retirant sa batterie. Votre MacBook est fourni avec un minimum de 512 mégaoctets 
(Mo) de mémoire DDR2 (Double Data Rate) 667 MHz SDRAM (Synchronous Dynamic 
Random-Access Memory). Les deux logements de mémoire peuvent accueillir un module 
SDRAM conforme aux spécifications suivantes :
Â format DDR2 SO-DIMM (Double Data Rate Small Outline Dual Inline Memory Module) ;
Â taille inférieure à 3,8 cm ;
Â 256 Mo, 512 Mo ou 1 Go ;
Avertissement : Apple vous recommande de confier l’installation de mémoire à un 
technicien agréé Apple. Consultez les informations sur l’assistance technique fournies 
avec l’ordinateur pour savoir comment joindre la société Apple. Tout dommage causé 
à votre matériel en tentant d’installer vous-même de la mémoire n’est pas couvert par 
la garantie limitée de votre ordinateur.
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Â 200 broches ;
Â mémoire RAM de type PC2-5300 DDR2 667 MHz.
Pour optimiser les performances, installez des modules mémoire de même type dans 
chaque logement. La quantité maximale de mémoire que vous pouvez installer sur votre 
MacBook est de 2 Go, en insérant une barrette DIMM de 1 Go dans chaque logement.
Installation de mémoire supplémentaire
Pour installer de la mémoire, il faut enlever et remettre en place la batterie. La procédure 
suivante inclut des instructions sur l’ajout de mémoire et la remise en place de la batterie.
Étape 1 : retrait de la batterie
1 Éteignez votre MacBook. Débranchez l’adaptateur secteur, le câble Ethernet et tous 
les autres câbles connectés au MacBook afin d’éviter toute détérioration.
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2 Retournez le MacBook et repérez l’emplacement du verrou de la batterie. Utilisez une 
pièce de monnaie pour faire tourner le verrou d’un quart de tour vers la droite afin de 
débloquer la batterie, puis retirez cette dernière avec précaution.
Avertissement : les composants internes de votre MacBook risquent d’être chauds. 
Si vous venez d’utiliser votre MacBook, attendez 10 minutes après l’extinction, afin de 
laisser aux composants internes le temps de se refroidir.
¥
Á
¥
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Étape 2 : installation de mémoire
1 Desserrez les trois vis imperdables maintenant le support en L, tirez sur la barre la plus 
longue pour retirer le support et écartez celui-ci. 
Les leviers situés dans les logements de mémoire se soulèvent automatiquement 
lorsque vous retirez le support.
2 Touchez la surface métallique de l’intérieur de l’ordinateur afin de décharger toute 
électricité statique que vous pouvez avoir emmagasinée.
Desserrez les trois vis
Tirez sur cette barre
¥
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3 Pour retirer un module de mémoire installé dans un logement, placez le levier correspondant complètement vers la gauche jusqu’à ce que le bord du module de mémoire 
se soulève. Retirez le module de mémoire. Répétez l’opération avec l’autre module de 
mémoire.
Leviers
¥
Á
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4 Insérez les nouveaux modules de mémoire dans les logements :
a Commencez par insérer le bord doré, avec l’encoche sur le côté gauche.
bPoussez fermement avec deux doigts sur les modules de mémoire pour les mettre en 
place. Vous devriez entendre un clic lorsque la mémoire s’enclenche.
c Si les leviers ne reviennent pas en position fermée, déplacez-les vers la droite pour 
les fermer.
Encoches
¥
Á
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5 Replacez le support en L en insérant d’abord le bras le plus court, puis resserrez les vis.
Insérez Resserrez les trois vis
d’abord 
ce bras
¥
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Étape 3 : remplacement de la batterie
1 Placez le bord droit de la batterie dans son compartiment. Appuyez doucement sur 
le bord gauche de la batterie jusqu’à ce que le loquet soit bloqué.
2 Reconnectez l’adaptateur secteur et tout autre câble connecté auparavant à l’ordinateur.
¥
Á
¥
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Reconnaissance de la nouvelle mémoire par votre MacBook
Après avoir ajouté de la mémoire dans votre MacBook, vérifiez si elle est reconnue. 
Pour vérifier la mémoire de votre ordinateur :
1 Démarrez votre MacBook.
2 Lorsque le bureau Mac OS s’affiche, choisissez le menu Pomme () > À propos de ce Mac.
Pour plus de détails sur la mémoire installée sur votre ordinateur, ouvrez 
Informations Système en cliquant sur Plus d’infos puis sur Mémoire. 
Si votre ordinateur ne reconnaît pas la mémoire ou qu’il ne démarre pas correctement, 
éteignez-le et relisez les instructions afin de vous assurer que la mémoire est correctement installée et compatible avec votre MacBook. Si les problèmes persistent, retirez la 
mémoire et consultez les informations d’assistance technique fournies avec la mémoire 
ou contactez le fournisseur de la mémoire. 
Mémoire totale installée 
sur votre MacBook
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5 Dépannage
Si vous rencontrez un problème avec votre MacBook, 
commencez par rechercher ici des solutions et des 
conseils. 
Il existe généralement une solution simple et rapide aux problèmes que vous pourriez 
rencontrer au cours de l’utilisation de votre MacBook. Réfléchissez aux conditions qui 
ont entraîné l’apparition de ce problème. Ce récapitulatif de la totalité des opérations 
effectuées avant que le problème ne survienne permet de restreindre les causes possible 
et de trouver la solution. 
Notez les choses suivantes :
Â les applications que vous étiez en train d’utiliser quand le problème est apparu ; les 
problèmes qui n’apparaissent qu’avec une application spécifique peuvent indiquer 
que cette application n’est pas compatible avec la version de Mac OS installée sur 
votre ordinateur ;
Â les logiciels que vous avez installés récemment, notamment ceux qui ont ajouté des 
éléments à votre Dossier Système ;
Â tout composant matériel installé (mémoire supplémentaire ou périphérique, 
par exemple).
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Vous trouverez des informations supplémentaires concernant le dépannage dans 
l’Aide Mac et sur le site web de service et d’assistance Apple à l’adresse 
www.apple.com/fr/support.
Problèmes vous empêchant d’utiliser votre ordinateur
Si l’ordinateur ne répond plus ou que le pointeur se fige
Â Appuyez sur Commande (x) + Option + Échap pour forcer la fermeture d’une application figée. Sélectionnez l’application que vous souhaitez quitter dans le zone de 
dialogue qui apparaît, puis cliquez sur Forcer à quitter.
Enregistrez ensuite votre travail dans les applications ouvertes, puis redémarrez 
l’ordinateur afin de vous assurer que le problème est entièrement réglé. 
Â Si vous ne parvenez pas à forcer la fermeture d’une application, maintenez enfoncé 
le bouton d’alimentation (®) durant quelques secondes pour éteindre l’ordinateur.
Â Si l’ordinateur ne répond toujours pas, essayez de le redémarrer en appuyant simultanément sur le bouton d’alimentation (®) et les touches Commande (x) et Contrôle.
Si le problème survient fréquemment, choisissez Aide > Aide Mac dans la barre des menus 
en haut de l’écran. Recherchez le mot «bloquer» pour obtenir de l’aide en cas de blocage 
de l’ordinateur ou s’il ne répond pas.
Si le problème ne survient que lorsque vous utilisez une application particulière, vérifiez 
auprès de son éditeur si elle est compatible avec votre ordinateur. Si vous savez qu’une 
application est compatible, vous devrez peut-être réinstaller le logiciel système de 
votre ordinateur.
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Si l’ordinateur se bloque au démarrage, un point d’interrogation clignotant apparaît 
ou l’écran est éteint et la lampe témoin de suspension d’activité reste allumée (pas 
en mode de suspension d’activité)
Â Patientez quelques secondes. Si l’ordinateur ne démarre pas après un court instant, 
éteignez-le en maintenant le bouton d’alimentation (®) enfoncé pendant 5 secondes 
environ, jusqu’à ce qu’il s’éteigne complètement. Maintenez ensuite la touche Option 
enfoncée puis appuyez à nouveau sur le bouton d’alimentation (®) pour démarrer votre 
ordinateur. Lorsque votre ordinateur démarre, cliquez sur l’icône du disque dur, puis 
sur la flèche droite. Une fois que l’ordinateur a démarré, ouvrez Préférences Système et 
cliquez sur Démarrage. Sélectionnez un dossier Système Mac OS X.
Â Si cela ne donne pas de résultats, essayez d’utiliser Utilitaire de disque pour réparer 
le disque. Insérez le disque 1 d’installation de Mac OS X dans votre ordinateur. Redé-
marrez ensuite votre ordinateur en maintenant la touche C enfoncée lors du démarrage. Choisissez Installation > Ouvrir Utilitaire de disque. Lorsque Utilitaire de disque 
s’ouvre, suivez les instructions dans la fenêtre S.O.S pour tenter de le réparer.
Si Utilitaire de disque ne résout pas le problème, vous devrez peut-être réinstaller 
le logiciel système de votre ordinateur. Pour obtenir des instructions, consultez la 
section «Réinstallation des logiciels fournis avec votre ordinateur» à la page 106.
Si l’ordinateur ne s’allume ou ne démarre pas
Â Assurez-vous que l’adaptateur secteur est connecté à l’ordinateur et branché sur une 
prise secteur en état de marche. Veillez à utiliser l’adaptateur secteur fourni avec votre 
ordinateur. Si l’adaptateur secteur ne recharge plus l’ordinateur et que la lampe témoin 
de l’adaptateur secteur ne s’allume pas lorsque vous branchez le câble d’alimentation, 
essayez de le débrancher puis de le brancher à nouveau afin de le réinitialiser.
F3626M42.book Page 101 Wednesday, April 5, 2006 2:17 PM102 Chapitre 5 Dépannage
Â Vérifiez si votre batterie à besoin d’être rechargée. Appuyez sur le petit bouton situé 
sur la batterie. Vous devriez voir apparaître un à quatre voyants indiquant le niveau 
de charge de la batterie. Si une seule lampe témoin de niveau de la batterie clignote, 
branchez l’adaptateur secteur pour charger la batterie jusqu’à ce qu’au moins une 
lampe témoin reste allumée en permanence.
Â Si vous avez suivi les deux premiers conseils sans succès, rétablissez les réglages par 
défaut de l’ordinateur en débranchant l’adaptateur secteur, en retirant la batterie et 
en maintenant le bouton d’alimentation (®) enfoncé pendant au moins 5 secondes. 
Â Si vous avez récemment ajouté de la mémoire, assurez-vous qu’elle est correctement 
installée et compatible avec votre ordinateur. Vérifiez si son retrait permet à l’ordinateur de démarrer (voir «installation de mémoire» à la page 92). 
Â Si cela ne fonctionne pas, appuyez sur le bouton d’alimentation (®) et maintenez 
immédiatement les touches Commande (x), Option, P et R enfoncées jusqu’à ce 
que vous entendiez une deuxième fois le signal sonore de démarrage. 
Â Si vous ne parvenez toujours pas à démarrer votre MacBook, consultez les informations 
sur service après-vente fournies avec votre MacBook pour savoir comment contacter 
Apple.
Si l’écran devient soudainement noir ou que votre système se bloque
Essayez de redémarrer votre ordinateur. 
1 Débranchez tout périphérique connecté à votre MacBook excepté l’adaptateur secteur.
2 Maintenez les touches Commande (x) et Contrôle enfoncées, puis appuyez sur le bouton 
d’alimentation (®) pour redémarrer le système.
3 Le niveau de charge de la batterie doit atteindre au moins 10 pour cent avant 
la connexion d’un périphérique et la reprise du travail. 
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Pour vérifier le niveau de charge de la batterie, observez le menu d’état Batterie dans 
la barre des menus.
Votre écran pourrait également s’assombrir si les fonctions d’économie d’énergie sont 
réglées pour l’utilisation de la batterie. Pour plus d’informations, consultez la section 
«Réglage de l’écran» à la page 30.
Autres problèmes
Si vous avez oublié votre mot de passe
Vous pouvez réinitialiser votre mot de passe d’administrateur et les mots de passe de 
tous les autres comptes.
1 Insérez le CD «Mac OS X Install Disc 1». Ensuite, redémarrez votre ordinateur et maintenez la touche C enfoncée pendant le démarrage.
2 Choisissez Installation > Réinitialiser le mot de passe dans la barre des menus. Suivez 
les instructions à l’écran.
En cas de problème avec une application
Â Pour les problèmes liés aux logiciels provenant d’éditeurs tiers, contactez l’éditeur 
concerné. Les éditeurs de logiciels fournissent souvent des mises à jour logicielles 
sur leurs sites web.
Â Vous pouvez configurer votre MacBook pour qu’il cherche et installe automatiquement les dernières mises à jour Apple via la fenêtre Mise à jour de logiciels des 
Préférences Système. Pour plus d’informations, choisissez Aide > Aide Mac, puis 
recherchez «mise à jour de logiciels».
Remarque : les applications Classic (ou Mac OS 9) ne sont pas compatibles avec votre 
ordinateur et ne s’ouvriront pas.
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En cas de problèmes avec les communications sans fil AirPort Extreme
Â Vérifiez que l’ordinateur ou le réseau auquel vous souhaitez vous connecter est activé 
et dispose d’un point d’accès sans fil.
Â Assurez-vous que vous êtes bien dans la zone de couverture de l’antenne de l’autre 
ordinateur ou du point d’accès du réseau en vérifiant le menu d’état AirPort (Z) 
dans la barre des menus. Jusqu’à quatre barres de mesure apparaissent pour indiquer 
la puissance du signal.
Des appareils électroniques ou des structures métalliques se trouvant à proximité 
peuvent interférer avec les communications sans fil et réduire la portée de votre 
antenne. Vous pouvez éventuellement améliorer la réception en tournant et en 
réorientant l’ordinateur.
Â Assurez-vous que le logiciel est correctement configuré conformément aux instructions 
incluses avec votre borne d’accès ou point d‘accès.
Â Pour plus d’informations, consultez l’Aide AirPort (choisissez Aide > Aide Mac, puis 
Bibliothèque > Aide AirPort dans la barre des menus), ainsi que les instructions 
fournies avec votre appareil sans fil.
Si le disque dur de votre ordinateur n’enregistre pas les données correctement
Â Il peut arriver, dans certains cas très rares, qu’en raison de vibrations anormalement 
fortes subies par le disque dur, le capteur Sudden Motion Sensor s’active et provoque des pertes d’images ou des portions de son ou de données non enregistrées 
lorsque le disque est en train d’enregistrer de manière intensive. Si cela se produit, 
assurez-vous que votre MacBook est dans un environnement stable sans vibrations 
ni mouvements brusques.
Â Si les vibrations ne sont pas la source du problème, ouvrez Utilitaire de disque 
(dans /Applications/Utilitaires) pour vérifier le lecteur. 
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En cas de problème à l’éjection d’un disque
m Fermez toutes les applications susceptibles d’utiliser le disque et essayez à nouveau. 
Si cela ne donne pas de résultats, redémarrez l’ordinateur tout en maintenant le bouton 
du trackpad enfoncé.
Si vous suspectez un problème matériel
Â Vous pouvez utiliser l’application «Apple Hardware Test» pour déterminer s’il existe 
un problème dû à l’un des composants de votre ordinateur, tels que la mémoire ou 
le processeur.
Pour plus d’informations sur Apple Hardware Test, consultez la section «Utilisation 
d’Apple Hardware Test» à la page 108.
En cas de problèmes de connexion à Internet
Â Assurez-vous que votre ligne téléphonique ou que votre câble réseau est connecté 
et qu’il fonctionne correctement.
Â Si vous utilisez une connexion à Internet par ligne commutée, veillez à ce que votre 
câble téléphonique soit bien branché sur le modem USB d’Apple (vendu séparément) 
et non au port Ethernet (G) de l’ordinateur.
Â Ouvrez la fenêtre Réseau des Préférences Système et vérifiez auprès de votre Fournisseur 
d’Accès Internet (FAI) ou de votre administrateur réseau les informations qui y sont saisies.
En cas de problèmes de fonctionnement de votre ordinateur ou de Mac OS
Â Si les réponses à vos questions ne figurent pas dans ce manuel, choisissez Aide > 
Aide Mac dans la barre des menus et recherchez des instructions et des informations 
sur le dépannage.
Â Pour obtenir les dernières informations de dépannage et des mises à jour de logiciels, 
consultez le site web d’assistance Apple, à l’adresse www.apple.com/fr/support.
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Réinstallation des logiciels fournis avec votre ordinateur
Les disques d’installation de logiciels fournis avec votre ordinateur permettent de 
réinstaller Mac OS X et les applications livrées avec votre ordinateur.
Important : Apple vous recommande de sauvegarder les données de votre disque dur 
avant de procéder à la restauration du logiciel. Apple décline toute responsabilité en 
cas de perte de données.
Installation de Mac OS X et des applications
Pour installer Mac OS X et les applications qui accompagnent votre ordinateur :
1 Sauvegardez vos fichiers essentiels.
Nous vous conseillons de sauvegarder vos fichiers essentiels avant d’installer Mac OS X 
et d’autres applications car l’option Effacer et installer efface votre disque de destination.
2 Assurez-vous que l’adaptateur secteur est correctement branché.
3 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur.
4 Double-cliquez sur «Install Mac OS X and Bundled Software».
5 Suivez les instructions à l’écran.
6 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran. Il se peut que votre ordinateur redémarre et vous invite à insérer le disque 
d’installation Mac OS X suivant.
Remarque : pour rétablir les réglages d’origine de Mac OS X sur votre ordinateur, 
cliquez sur Options dans la fenêtre Sélectionner une destination du programme 
d’installation, puis choisissez Effacer et installer. 
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Après avoir sélectionné le disque de destination de l’installation, continuez à suivre les 
instructions à l’écran pour effectuer une installation de base de Mac OS X. Pour personnaliser l’installation des applications, cliquez sur Personnaliser, cliquez sur le triangle en 
regard de l’application et sélectionnez la version que vous souhaitez installer.
Installation des applications
Pour installer uniquement les applications fournies avec votre ordinateur, veuillez 
procéder comme suit. Mac OS X doit déjà être installé sur votre ordinateur.
1 Sauvegardez vos fichiers essentiels.
2 Assurez-vous que l’adaptateur secteur est correctement branché.
3 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur.
4 Double-cliquez sur «Install Bundled Software Only».
5 Suivez les instructions à l’écran.
6 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran. Il se peut que votre ordinateur redémarre et vous invite à insérer le disque 
d’installation Mac OS X suivant.
Remarque : pour installer iCal, iChat AV, iSync, Safari et les applications iLife, suivez les 
instructions exposées dans «Installation de Mac OS X et des applications» à la page 106. 
Il est possible que vous deviez insérer le disque 2 d’installation de Mac OS X, selon les 
applications que vous souhaitez installer.
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Utilisation d’Apple Hardware Test
Apple Hardware Test vous aide à déterminer s’il existe un problème matériel sur votre 
ordinateur. 
Pour utiliser Apple Hardware Test :
1 Déconnectez tous les périphériques externes de votre ordinateur, sauf l’adaptateur 
secteur. Si un câble Ethernet est connecté, déconnectez-le.
2 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur. 
3 Redémarrez ensuite votre ordinateur en maintenant la touche D enfoncée lors du 
démarrage.
4 Lorsque l’écran principal d’Apple Hardware Test s’affiche, suivez les instructions à l’écran.
5 En cas de détection d’un problème, Apple Hardware Test affiche un code d’erreur. Notez 
le code d’erreur avant d’entreprendre les démarches d’assistance. Si Apple Hardware Test 
ne détecte pas de panne matérielle, il est probable que le problème soit lié aux logiciels.
Pour en savoir plus sur Apple Hardware Test, consultez le fichier «À propos d’AHT» sur 
le disque «Mac OS X Install Disc 1».
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Localisation du numéro de série de votre produit
Utilisez l’une des méthodes suivantes pour trouver le numéro de série de votre 
ordinateur :
Â Choisissez Apple () > À propos de ce Mac puis cliquez sur le numéro de version 
au-dessous des mots «Mac OS X». Cliquez pour afficher l’un après l’autre la version 
de Mac OS X, le numéro de sous-version et le numéro de série. 
Â Ouvrez Informations Système (dans /Applications/Utilitaires/), et cliquez sur Matériel. 
Vous pouvez également ouvrir Informations Système en cliquant sur le bouton Plus 
d’infos dans la zone de dialogue À propos de ce Mac.
Â Retirez la batterie. Le numéro de série de votre MacBook se trouve dans la baie de la 
batterie. Pour en savoir plus sur l’extraction de la batterie, consultez la section «retrait 
de la batterie» à la page 90 . 
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A Annexe
A Caractéristiques
Vous pouvez utiliser Informations Système pour 
obtenir des informations détaillées sur votre MacBook.
Vous y trouverez entre autres la quantité de mémoire vive, la taille du disque dur, les 
périphériques connectés et le numéro de série du produit. Pour accéder au contenu 
des Informations Système, sélectionnez le menu Pomme () > À propos de ce Mac 
dans la barre des menus, puis cliquez sur Plus d’infos ou ouvrez Informations Système, 
situé dans /Applications/Utilitaires.
Dans la fenêtre qui s’ouvre, cliquez sur 
les triangles pour afficher ou cacher 
le contenu des différentes catégories.
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Conditions de fonctionnement
Â Température de fonctionnement : 10° C à 35° C
Â Altitude : 3 048 m maximum
Â Humidité relative : de 0 % à 90 % sans condensation
Adaptateur secteur
Â Entrée : 100 à 240 Volts (V), 50/60 Hertz (Hz)
Â Sortie : 16,5 V à 3,65 A
Batterie
Â Sortie : 10,8 V 
Â Capacité : 55 Wh 
Des informations supplémentaires sont disponibles sur le site d’Apple aux pages 
www.apple.com/fr/macbook et www.apple.com/fr/support.
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Annexe
B Consignes de sécurité, 
d’utilisation et d’entretien
Veuillez lire attentivement les consignes de sécurité 
et d’entretien suivantes concernant votre MacBook.
Les produits Apple sont conçus et évalués selon les standards de sécurité les plus 
récents de l’équipement des technologies de l’information. Cependant, pour assurer 
une utilisation sûre, il est important de suivre les consignes de sécurité indiquées sur 
le produit et dans la documentation.
Consignes générales de sécurité
Lisez et suivez toutes les consignes indiquées sur le produit et dans ce manuel avant 
d’utiliser votre MacBook. Gardez ces instructions dans un endroit facile d’accès pour 
vous et pour les utilisateurs éventuels.
Â Installez votre MacBook sur un plan de travail stable.
Â Évitez de placer votre ordinateur à proximité d’un évier, d’un lavabo, d’une baignoire 
ou d’une douche, par exemple.
Â Protégez votre ordinateur de l’humidité et des intempéries (neige, pluie, brouillard 
par exemple).
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Â Pour votre propre sécurité et celle de votre matériel, veillez à toujours prendre les 
précautions ci-après. Débranchez le cordon d’alimentation (en tirant sur la prise 
plutôt que sur le cordon), retirez la batterie et débranchez tous les autres câbles si 
l’un des cas suivants se présente :
Â Vous souhaitez installer de la mémoire.
Â Vous voulez retirer un ou plusieurs composants.
Â La prise ou le câble d’alimentation est endommagé.
Â Un liquide a été renversé dans le boîtier.
Â Votre ordinateur est exposé à la pluie ou à une humidité excessive.
Â Votre ordinateur a subi une chute ou le boîtier a été endommagé de quelque autre 
façon.
Â Vous pensez que votre ordinateur a besoin d’être inspecté ou réparé.
Â Vous souhaitez nettoyer le boîtier (pour ce faire, suivez à la lettre les instructions 
fournies plus bas).
Â Le port d’adaptateur secteur du MacBook contient un aimant. Ne mettez pas des 
matériaux ou des appareils à sensibilité magnétique à 25 mm ou moins de ce port.
Â N’introduisez jamais d’objets d’aucune sorte dans les ouvertures de ventilation de 
le MacBook.
Â La batterie du MacBook peut présenter un risque d’incendie ou de brûlure en cas de 
mauvais traitement. Ne la désassemblez pas, ne la chauffez pas au-delà de 100 º C 
et ne l’incinérez pas. Ne remplacez la batterie que par une batterie certifiée par Apple 
pour ce produit. L’utilisation de toute autre batterie peut présenter un risque d’incendie 
ou d’explosion. Éliminez rapidement les batteries usagées conformément aux directives 
d’environnement locales en vigueur.
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Configuration de votre MacBook et de l’adaptateur secteur
Assurez-vous que la fiche ou le câble d’alimentation CA est complètement inséré dans 
l’adaptateur secteur avant de brancher l’adaptateur sur la prise secteur. Pour un fonctionnement optimal, veillez à connecter l’adaptateur via le câble d’alimentation CA et 
à utiliser une prise secteur de terre.
Utilisez uniquement l’adaptateur secteur fourni avec votre MacBook. Les adaptateurs destinés à d’autres appareils électroniques (y compris à d’autres modèles de MacBook Pro et 
d’ordinateurs portables) peuvent sembler similaires, mais risquent d’avoir une incidence 
négative sur les performances de votre ordinateur, voire de l’endommager.
L’adaptateur secteur peut chauffer pendant l’utilisation normale de votre MacBook. 
Faites toujours en sorte que l’adaptateur soit correctement ventilé et soyez prudent 
lorsque vous le manipulez pendant ou immédiatement après l’avoir utilisé. Si possible, 
placez l’adaptateur secteur sur une surface plane et dure pour dissiper la chaleur.
Ne forcez jamais l’insertion d’un connecteur dans un port. Vérifiez la présence d’obstructions sur le port. Si le connecteur ne se raccorde pas facilement au port, c’est qu’ils 
sont probablement incompatibles. Assurez-vous que le connecteur correspond bien au 
port et que vous l’avez correctement positionné par rapport à ce dernier.
La présence de débris dans le port d’adaptateur secteur peut empêcher l’adaptateur 
secteur de se brancher correctement. Nettoyez doucement les débris avec une tige 
de coton ouaté.
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Utilisation de votre MacBook
Lorsque vous utilisez votre MacBook ou que vous rechargez la batterie, il est normal 
que la température du dessous du boîtier s’élève. En cas d’utilisation prolongée, placez 
votre MacBook sur une surface plane et stable. 
Ne laissez pas la partie inférieure de votre MacBook au contact de vos genoux ou de 
toute autre surface de votre corps de manière prolongée. Un contact étendu avec votre 
corps pourrait provoquer des douleurs et éventuellement des brûlures.
Cette partie du boîtier du MacBook sert de surface de refroidissement et permet d’évacuer la chaleur de l’ordinateur vers l’extérieur. Le dessous du boîtier est légèrement suré-
levé pour permettre la circulation d’air et assurer ainsi à l’équipement une température 
de fonctionnement normale. De plus, l’ordinateur dégage de l’air chaud des logements 
à l’arrière du boîtier.
Avertissement : ne posez pas votre MacBook allumé sur un oreiller ou toute autre surface dans laquelle il pourrait s’enfoncer, car cela pourrait bloquer les conduites d’aération, en particulier les conduites arrière, et entraîner une surchauffe de l’ordinateur. 
Évitez également de placer des objets sur le clavier lors de l’utilisation avec écran 
rabattu. Cela risque de provoquer une succession d’arrêts et de mises en marche de 
votre ordinateur, entraînant une surchauffe et la décharge de la batterie. N’allumez 
jamais l’ordinateur tant que tous ses composants internes ou externes ne sont pas 
en place. L’utilisation de l’ordinateur lorsque son boîtier est ouvert ou que certains 
composants ont été démontés peut s’avérer dangereuse et risque de l’endommager.
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Transport de votre MacBook
Si vous transportez votre MacBook dans un sac ou dans un attaché-case, assurez-vous que 
ce dernier ne contient pas d’objets non attachés (tels que des trombones ou des pièces 
de monnaie) qui pourraient pénétrer accidentellement dans l’ordinateur par une ouverture telle que la fente du lecteur optique ou se coincer à l’intérieur d’un port. Maintenez 
également à l’écart du port de l’adaptateur secteur tout objet magnétiquement sensible.
Rangement de votre MacBook
Si vous décidez de ranger votre MacBook pendant une période de temps prolongée, 
placez-le dans un endroit frais (idéalement à 22 ° C) et prenez l’une des mesures 
suivantes afin de préserver la durée de vie de la batterie :
Â Déchargez la batterie à 50 pour cent avant de ranger votre MacBook.
Â Avant de ranger votre ordinateur pour une période de temps supérieure à cinq mois, 
déchargez la batterie jusqu’à environ 50 pour cent, puis retirez-la du MacBook. Si vous 
décidez de ranger votre ordinateur pour une période prolongée, pensez à recharger la 
batterie de 50 pour cent tous les six mois environ.
Nettoyage de votre MacBook
Respectez les consignes suivantes lors du nettoyage de votre ordinateur et de ses 
accessoires :
Â Éteignez votre MacBook, débranchez l’adaptateur secteur et retirez la batterie.
Â Pour nettoyer le boîtier de l’ordinateur, utilisez un chiffon doux, humide et non 
pelucheux. Évitez les infiltrations d’humidité par quelque ouverture que ce soit. 
Ne vaporisez jamais de liquide directement sur l’ordinateur.
Â N’utilisez ni aérosols, ni dissolvants, ni abrasifs qui pourraient endommager le fini.
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Nettoyage de l’écran de votre MacBook
Pour nettoyer l’écran de votre MacBook, procédez comme suit :
Â Éteignez votre MacBook, débranchez l’adaptateur secteur et retirez la batterie.
Â Humidifiez, à l’eau seulement, un chiffon propre, doux et non pelucheux et essuyez 
l’écran. Ne vaporisez jamais de liquide directement sur l’écran.
Comment éviter les problèmes auditifs
Informations se rapportant au laser
Avertissement : l’utilisation d’écouteurs ou d’un casque d’écoute à un niveau de 
volume trop élevé peut provoquer une perte d’acuité auditive permanente. L’oreille 
peut s’adapter petit à petit à des volumes sonores de plus en plus élevés qui peuvent 
sembler normaux, mais qui risquent à la longue d’endommager votre système auditif. 
En cas de sifflements ou de perte d’acuité auditive, arrêtez d’utiliser le casque ou les 
écouteurs et consultez un médecin. Plus le volume est élevé, plus votre audition risque d’être affectée rapidement. Pour protéger votre système auditif, les spécialistes 
conseillent de prendre les mesures suivantes :
Â Limitez la durée d’utilisation à volume élevé de vos écouteurs ou de votre casque 
d’écoute.
Â Évitez d’augmenter le volume afin de bloquer les bruits environnants. 
Â Baissez le volume si vous ne parvenez pas à entendre une personne qui parle à côté 
de vous.
Avertissement : l’exécution de réglages ou d’opérations qui ne sont pas spécifiés dans 
la manuel de votre équipement risque de vous exposer à des rayonnements dangereux. 
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N’essayez pas de démonter le boîtier qui contient le laser. Le faisceau laser utilisé dans 
ce produit est nocif pour les yeux. L’utilisation d’instruments optiques, tels que les loupes grossissantes, avec ce produit augmente les risques potentiels pour vos yeux. Afin 
d’assurer votre sécurité, cet équipement ne doit être réparé que par un fournisseur de 
services agréé Apple. 
Votre ordinateur est classé comme produit laser de Catégorie 1 à cause de son lecteur 
optique. L’étiquette de Catégorie 1, située dans un emplacement accessible à l’utilisateur, indique que le lecteur obéit aux exigences minimales de sécurité. Une étiquette 
de mise en garde destinée au réparateur est située dans un emplacement qui lui est 
accessible. Les étiquettes placées sur votre produit peuvent être légèrement différentes 
de celles qui sont affichées ici.
Avertissement relatif aux activités à haut risque
Cet ordinateur n’est pas conçu pour être utilisé dans des installations nucléaires, pour 
la navigation ou la communication aérienne, pour le contrôle du trafic aérien, ni dans 
aucune autre situation où une panne du système informatique pourrait entraîner la 
mort, des blessures ou de graves dommages écologiques.
Étiquette 
«Catégorie 1»
Étiquette de mise en garde 
destinée au réparateur
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Ergonomie
Voici quelques conseils sur la mise en place d’un environnement de travail sain.
Clavier et trackpad
Lorsque vous tapez au clavier ou que vous vous servez du trackpad, vos épaules 
doivent être détendues. Le bras et l’avant-bras doivent former un angle droit, la main 
étant placée dans le prolongement du poignet.
Vous devez avoir les mains et les doigts détendus lorsque vous tapez au clavier ou 
que vous utilisez le trackpad. Évitez de replier les pouces à l’intérieur des paumes.
Position
à éviter
Position
recommandée
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Modifiez fréquemment la position de vos mains pour éviter la fatigue. Après un travail 
continu et intensif sur ordinateur, certains utilisateurs peuvent ressentir des douleurs 
aux mains, aux poignets ou aux bras. Si ces douleurs persistent, consultez un spécialiste.
Siège
Optez pour un siège de bureau réglable et offrant un dossier et une assise confortables. Réglez la hauteur du siège de telle sorte que vos cuisses reposent à l’horizontale 
et vos pieds à plat sur le sol. Le dossier du siège doit soutenir votre région lombaire, 
c’est-à-dire la partie inférieure de votre dos. Suivez les instructions du fabricant de 
sorte que le réglage du dossier soit parfaitement adapté à votre morphologie.
Au besoin, relevez le siège de manière à ce que vos avant-bras et vos mains soient 
placés correctement par rapport au clavier. Si, dans ce cas, vos pieds ne reposent plus 
à plat sur le sol, utilisez un repose-pied inclinable et réglable en hauteur. Si vous disposez d’un bureau modulaire, vous pouvez abaisser le niveau du plan de travail pour 
éviter l’emploi d’un repose-pied. Une troisième solution consiste à utiliser un bureau 
dont le clavier est situé plus bas que le plan de travail.
Position
à éviter
Position
recommandée
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Souris externe
Si vous utilisez une souris externe, veillez à ce qu’elle se trouve à hauteur du clavier. 
Ménagez un espace suffisant pour la manipuler avec aisance.
Écran intégré
Orientez l’écran de manière à réduire le plus possible les reflets de l’éclairage électrique 
et de la lumière du jour. Ne forcez pas l’écran si vous rencontrez une résistance. L’angle 
d’ouverture maximal de l’écran ne peut dépasser 130 degrés.
Réglez la luminosité et le contraste de l’écran chaque fois que vous déplacez l’ordinateur 
ou que l’éclairage ambiant change.
Pour en savoir plus
Accédez au site web www.apple.com/about/ergonomics.
À propos d’Apple et de l’environnement
Apple Computer, Inc. reconnaît sa responsabilité en matière de réduction de l’impact 
de ses produits et de ses activités sur l’environnement. Pour en savoir plus, consultez 
la page www.apple.com/environment/summary.html.
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Annexe
C Connexion à Internet
Votre ordinateur vous permet de naviguer sur le 
Web, d’échanger du courrier électronique avec vos 
amis et votre famille ou de dialoguer en temps réel 
via Internet. Utilisez ces informations pour vous 
aider à vous connecter à Internet.
Lors du premier démarrage de Mac OS X, Assistant réglages vous aide à saisir vos informations concernant la configuration Internet. Si vous n’avez pas utiliser Assistant réglages pour configurer votre connexion à Internet, vous pouvez utiliser Assistant réglages 
de Réseau plus tard (consultez «Utilisation d’Assistant réglages de réseau pour se connecter» à la page 127 ). Si vous choisissez de ne pas utiliser Assistant réglages de réseau, 
vous pouvez utiliser les informations figurant dans cette annexe pour configurer votre 
connexion manuellement.
Il existe quatre types de connexion à Internet :
Â connexion via un modem câble ou DSL à haut débit : l’ordinateur est relié via 
un câble Ethernet à un modem spécial fourni par un FAI ;
Â connexion sans fil : l’ordinateur est connecté sans fil via une borne d’accès 
AirPort Extreme, AirPort Express ou un autre point d’accès 802.11ou 802.11 ;
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Â réseau local (LAN) : l’ordinateur est connecté à un réseau local via un câble Ethernet. 
C’est le type de connexion habituellement utilisé dans les entreprises.
Â connexion par ligne téléphonique : l’ordinateur est connecté à un modem externe 
branché sur une prise téléphonique murale via un câble téléphonique.
Avant de vous connecter à Internet :
1 Ouvrez un compte auprès d’un fournisseur d’accès à Internet (FAI). 
2 Procurez-vous les informations concernant la connexion auprès de votre fournisseur 
d’accès à Internet ou de votre administrateur réseau. Consultez la section suivante 
«Regroupement des informations nécessaires», pour savoir quelles sont les informations dont vous avez besoin pour chaque type de connexion. Vous pouvez écrire ces 
informations directement sur les pages suivantes, puis les saisir dans Assistant réglages.
Si un autre ordinateur se trouvant au même emplacement est déjà connecté à Internet, 
vous pouvez probablement utiliser ses réglages. 
Pour accéder aux réglages sur un ordinateur Mac OS X :
Â Ouvrez la fenêtre Réseau des Préférences Système.
Â Dans le menu local Afficher, sélectionnez votre mode de connexion. 
Â Copiez les informations concernant votre connexion.
Pour accéder aux réglages d’un ordinateur Windows :
Les informations d’un PC Windows concernant la connexion se trouvent à deux endroits.
Â Pour rechercher l’adresse IP et le masque de sous-réseau, ouvrez le tableau de bord 
«Connexions Réseau et Internet».
Â Pour accéder aux informations relatives aux comptes d’utilisateurs, ouvrez le tableau de 
bord Comptes d’utilisateurs. 
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3 Si vous utilisez un modem externe, tel que le modem USB d’Apple (vendu séparément), 
branchez-le dans un port USB de votre MacBook, puis utilisez un câble téléphonique (non 
inclus) pour connecter le modem à une prise téléphonique murale. Si vous disposez d’un 
modem DSL ou câble, connectez-le à votre ordinateur en suivant les instructions incluses.
4 Allumez votre ordinateur et saisissez les informations dans Assistant réglages pour 
configurer votre connexion à Internet.
Remarque : si vous avez déjà démarré votre ordinateur sans utiliser Assistant réglages 
pour configurer votre connexion à Internet, consultez «Utilisation d’Assistant réglages 
de réseau pour se connecter» à la page 127 .
Regroupement des informations nécessaires
Vous pouvez noter sur ces pages les informations obtenues auprès de votre FAI, de 
votre administrateur réseau ou récupérées sur un autre ordinateur, puis les saisir dans 
Assistant réglages de réseau.
Pour configurer une connexion téléphonique classique, procurez-vous les informations 
suivantes :
Â nom du fournisseur d’accès ;
Â nom d’utilisateur ou de compte ;
Â mot de passe ;
Â numéro de téléphone du FAI ;
Â autre numéro de téléphone ;
Â préfixe pour obtenir la ligne externe.
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Pour configurer un modem DSL, un modem câble, un réseau local (LAN) ou une 
connexion AirPort Extreme sans fil, choisissez votre méthode de connexion (en cas 
de doute, adressez-vous à votre administrateur système ou à votre FAI) :
Â manuellement ;
Â utilisation de DHCP (Dynamic Host Configuration Protocol, protocole de configuration 
dynamique d’hôte) avec une adresse manuelle ;
Â via DHCP ;
Â via BootP ;
Â PPP (Point-to-Point Protocol, protocole point à point).
En cas de doute sur la méthode à utiliser, l’option «Via DHCP» peut s’avérer un bon 
choix car le réseau fournit automatiquement la plupart des informations requises.
Si vous sélectionnez «Manuellement» ou «Via DHCP avec une adresse manuelle», 
rassemblez les informations suivantes :
Â adresse IP ;
Â masque de sous-réseau ;
Â adresse du routeur.
Remarque : si vous sélectionnez «Utilisation de DHCP avec une adresse manuelle», 
vous n’avez pas besoin d’un masque de sous-réseau ou d’une adresse de routeur.
Si vous sélectionnez «Via DHCP», rassemblez les informations facultatives suivantes 
(demandez à votre FAI si c’est nécessaire) :
Â numéro de client DHCP ;
Â serveurs DNS.
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Si vous sélectionnez «PPPoE» (pour les connexions via PPP sur Ethernet ), rassemblez 
les informations suivantes :
Â fournisseur d’accès ;
Â nom de compte ;
Â mot de passe ;
Â nom de service PPPoE.
Les informations ci-dessous sont facultatives. Demandez à votre fournisseur d’accès à 
Internet ou à votre administrateur système si elles sont requises.
Â serveurs DNS ;
Â nom de domaine ;
Â serveur proxy.
Saisie de vos informations
Après vous être procuré les informations spécifiques concernant la configuration auprès 
de votre FAI ou de votre administrateur réseau, vous pouvez utiliser Assistant réglages 
de réseau pour vous connecter ou pour saisir les informations manuellement. 
Utilisation d’Assistant réglages de réseau pour se connecter
Si vous n’avez pas utilisé l’Assistant réglages pour configurer vos réglages Internet 
au premier démarrage de votre MacBook, vous pouvez utiliser l’Assistant réglages de 
réseau à tout moment pour configurer votre connexion à Internet ou pour modifier 
vos réglages. 
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Pour utiliser Assistant réglages de réseau :
1 Choisissez le menu Pomme () > Préférences Système.
2 Cliquez sur Réseau puis cliquez sur «Assistant». 
3 Cliquez sur Assistant pour lancer Assistant réglages de réseau.
4 Suivez les instructions à l’écran.
Pour plus d’informations sur la configuration d’une connexion à Internet, consultez 
l’Aide Mac. Choisissez Aide > Aide Mac puis recherchez «connexion à Internet».
Saisie manuelle de vos informations
Pour saisir vos informations manuellement :
1 Ouvrez Préférences Système > Réseau.
2 Faites votre sélection dans le menu local Afficher et réglez les options selon le type de 
connexion souhaité :
Â connexion par modem câble, modem DSL ou LAN en utilisant l’une de ces 
configurations :
Â manuellement : dans le cas d’une configuration manuelle, votre FAI ou administrateur réseau vous indique une adresse IP statique et d’autres informations que vous 
devez saisir dans les Préférences réseau ;
Â utilisation du protocole DHCP (Dynamic Host Configuration Protocol) : avec 
une configuration DHCP, le serveur DHCP saisit automatiquement les informations 
à votre place ;
Â utilisation du protocole PPPoE (Point-to-Point Protocol over Ethernet) : si vous 
utilisez un modem DSL et que vous avez besoin d’un nom d’utilisateur et d’un mot 
de passe pour vous connecter à Internet, contactez votre FAI pour savoir si vous 
devez vous connecter via PPPoE ; 
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Â modem téléphonique externe avec connexion PPP (Point-to-Point Protocol) : saisissez 
le nom et le mot de passe de votre compte, votre numéro de téléphone et les autres 
informations requises ;
Â connexion sans fil AirPort Extreme : vous pouvez configurer votre réseau AirPort 
Extreme et votre connexion Internet via Assistant réglages AirPort, situé dans le 
dossier /Applications/Utilitaires. 
3 Cliquez sur «Assistant» pour obtenir une assistance supplémentaire. 
Dépannage de votre connexion
En cas de problèmes avec votre connexion à Internet, vous pouvez essayer les méthodes 
de cette section pour votre type de connexion ou vous pouvez utiliser Diagnostic réseau.
Pour utiliser Diagnostic réseau :
1 Choisissez le menu Pomme () > Préférences Système.
2 Cliquez sur Réseau puis cliquez sur «Assistant». 
3 Cliquez sur Diagnostic pour lancer Diagnostic réseau.
4 Suivez les instructions à l’écran.
Si Diagnostic réseau n’est pas en mesure de résoudre le problème, celui-ci se situe 
peut-être au niveau du fournisseur d’accès à Internet auquel vous essayez de vous 
connecter, du périphérique externe utilisé pour la connexion au fournisseur d’accès à 
Internet ou du serveur auquel vous essayez d’accéder. Vous pouvez également essayer 
les méthodes suivantes.
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Connexions à Internet par modem câble, modem DSL ou réseau 
local (LAN)
Si vous ne parvenez pas à vous connecter à Internet à l’aide de votre modem câble 
ou DSL ou via votre réseau local (LAN), suivez les instructions ci-après. 
Important : les instructions relatives aux modems ne concernent pas les utilisateurs 
de réseau LAN. Contrairement aux utilisateurs de modems câble et de modems DSL, 
les utilisateurs de réseau LAN peuvent disposer de concentrateurs, commutateurs, 
routeurs et autres dispositifs de connexion. Ils doivent faire appel à leur administrateur 
réseau plutôt qu’à un FAI.
Vérifiez les câbles et les sources d’alimentation
Assurez-vous que tous les câbles du modem sont correctement branchés, y compris 
le câble d’alimentation du modem, le câble reliant le modem à l’ordinateur et le câble 
raccordant le modem à la prise murale. Vérifiez les câbles et l’alimentation des routeurs 
et des concentrateurs Ethernet. 
Éteignez puis rallumez le modem et réinitialisez les composants matériels du modem.
Éteignez votre modem DSL ou votre modem câble pendant quelques minutes, puis 
rallumez-le. Certains fournisseurs d’accès à Internet conseillent de débrancher le câble 
d’alimentation du modem. Si votre modem dispose d’un bouton de réinitialisation, 
vous pouvez l’actionner avant ou après avoir éteint puis rallumé le modem.
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Connexions PPPoE 
Si vous n’arrivez pas à vous connecter à votre fournisseur d’accès à Internet via PPPoE, 
commencez par vérifier les câbles et l’alimentation, puis éteignez le modem et rallumez-le et réinitialisez le matériel modem. Vérifiez ensuite vos réglages dans la fenêtre 
Réseau des Préférences Système.
Pour vérifier les réglages des Préférences Système :
1 Choisissez le menu Pomme () > Préférences Système dans la barre des menus.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez Configurations de ports réseau.
4 Sélectionnez Ethernet intégré, puis faites glisser cette configuration en haut de la liste 
des configurations de ports. 
5 Dans le menu local Afficher, sélectionnez Ethernet intégré.
6 Cliquez sur PPPoE. 
7 Sélectionnez Se connecter via PPPoE.
8 Vérifiez le champ Nom de compte pour vous assurer d’avoir tapé les informations 
correctes fournies par votre fournisseur d’accès à Internet. 
9 Si vous avez choisi d’enregistrer votre mot de passe, saisissez-le à nouveau afin d’être 
sûr qu’il est correct. 
10 Cliquez sur TCP/IP. Assurez-vous d’avoir saisi dans cette fenêtre les informations correctes 
fournies par votre fournisseur d’accès à Internet. 
11 Cliquez sur Appliquer.
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Connexions au réseau
Si vous disposez de plusieurs ordinateurs tentant de partager une connexion à Internet, 
assurez-vous que votre réseau est correctement configuré. Vous devez savoir si votre 
fournisseur d’accès à Internet fournit une adresse IP ou plusieurs (une pour chaque 
ordinateur).
Si une seule adresse IP est utilisée, vous devez disposer d’un routeur capable de partager la connexion (on parle alors de conversion d’adresse réseau (NAT) ou de masquage 
d’adresses IP). Pour obtenir des informations sur la configuration, consultez la documentation fournie avec votre routeur ou contactez la personne qui a configuré votre 
réseau. La borne d’accès AirPort Extreme peut être utilisée pour que plusieurs ordinateurs partagent une adresse IP. Pour obtenir plus d’informations sur l’utilisation de 
la borne d’accès AirPort Extreme, consultez l’aide à l’écran ou le site web AirPort, à 
l’adresse www.apple.com/fr/airportextreme.
Si ces instructions s’avèrent insuffisantes pour résoudre les problèmes rencontrés, 
contactez votre fournisseur d’accès à Internet.
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DAnnexe
D Les dix questions principales
Une question ? Les dix questions les plus 
fréquemment posées par les nouveaux 
utilisateurs du MacBook sont les suivantes : 
Ma connexion Internet ne semble pas fonctionner. Comment la configurer ?
Il y a différents types de connexions Internet. Vous pouvez, par exemple, vous connecter via un modem, une connexion DSL, une connexion sans fil AirPort ou un réseau 
Ethernet. Vous devez saisir sous Mac OS X des informations spécifiques sur votre type 
de connexion, votre fournisseur d’accès Internet ou votre réseau. La première étape de 
configuration de votre connexion consiste à regrouper les informations requises pour 
votre type de connexion. Pour connaître les informations requises et savoir comment 
configurer votre type de connexion, consultez l’annexe C, «Connexion à Internet», à la 
page 123 . Votre ordinateur dispose également de l’application Assistant réglages pour 
vous aider à configurer votre connexion Internet. Ouvrez Préférences Système, puis 
cliquez sur Réseau. Cliquez sur le bouton d’assistance pour ouvrir Assistant réglages 
de réseau.
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Comment configurer mon imprimante ? Est-elle compatible avec mon MacBook ? 
Commencez par connecter votre imprimante et installer tous les logiciels en suivant les 
instructions incluses avec l’imprimante. Ensuite, ouvrez les Préférences Système, puis 
cliquez sur l’icône Imprimantes et fax. Utilisez la fenêtre Imprimantes et fax pour configurer votre MacBook de façon qu’il puisse utiliser l’imprimante. Vous trouverez de plus 
amples informations sur la configuration des imprimantes dans l’Aide Mac (choisissez 
Aide > Aide Mac dans la barre des menus, puis recherchez «imprimante»). Consultez 
également «Connexion à une imprimante» à la page 52. 
Si votre imprimante ne fonctionne pas comme prévu, consultez le site web du fabricant 
pour obtenir les gestionnaires d’imprimante mis à jour. La dernière version du logiciel 
d’imprimante est souvent disponible en téléchargement.
Si vous envoyez une tâche à votre imprimante et que celle-ci n’imprime pas, cliquez sur 
l’icône de l’imprimante dans le Dock pour vérifier si l’impression est interrompue ou 
si la tâche est en pause. (Si aucune icône n’apparaît dans le Dock, ouvrez Configuration 
d’imprimante dans le dossier /Applications/Utilitaires et double-cliquez sur le nom de 
l’imprimante.) Si la fenêtre de l’imprimante annonce «Tâche suspendue», cliquez sur 
le bouton Démarrer tâches. Si «Pause» apparaît à côté du nom de la tâche, reprenez 
l’impression en sélectionnant le nom de la tâche, puis en cliquant sur Reprendre. Si 
l’impression d’une tâche a été interrompue à la suite d’une erreur technique, effacez 
la tâche défectueuse en la sélectionnant et en cliquant sur Effacer. Essayer ensuite 
d’imprimer à nouveau la tâche.
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Comment fonctionne l’interface Mac OS X ?
Les utilisateurs qui découvrent Mac OS X se demandent souvent comment exécuter 
certaines tâches. L’ Aide Mac constitue la meilleure source d’informations sur Mac OS X. 
Elle comprend des explications préliminaires destinées aux nouveaux utilisateurs, aux 
utilisateurs Windows s’initiant à Mac OS X, ainsi qu’aux utilisateurs ayant effectué une 
mise à niveau de Mac OS 9. Ouvrez l’Aide Mac en choisissant Aide > Aide Mac dans la 
barre des menus du Finder, en haut de votre écran. Explorez les informations destinées 
aux nouveaux utilisateurs Mac OS X. La plupart des tâches élémentaires recherchées 
par l’utilisateur impliquent le Finder, essayez donc de rechercher «Finder» également.
Comment prolonger la longévité de la batterie de mon MacBook ?
N’oubliez pas d’étalonner votre batterie lors de la première utilisation (voir «Étalonnage 
de la batterie» à la page 26). Vous pouvez économiser l’énergie de la batterie en utilisant les options de la fenêtre des préférences Économiseur d’énergie pour spécifier 
quand l’ordinateur doit suspendre son activité et quand l’écran doit s’éteindre. Ouvrez 
Préférences Système et cliquez sur l’icône Économiseur d’énergie. Choisissez les réglages les mieux adaptés à votre mode d’utilisation. L’utilisation de périphériques, tels que 
les disques durs, qui tirent leur énergie de votre ordinateur, peut aussi contribuer à diminuer l’autonomie de votre batterie. Vous pouvez économiser l’énergie de la batterie 
en déconnectant ces appareils. Vous pouvez également vous procurer une batterie 
supplémentaire et la brancher sur votre ordinateur lorsque la batterie est faible. Pour 
obtenir plus d’informations sur les moyens d’économiser l’énergie de la batterie, 
consultez la section «Conseils pour économiser la batterie» à la page 85.
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J’ai inséré un disque dans le lecteur optique, mais rien ne se passe. Comment savoir 
si le disque est compatible avec mon lecteur optique ?
Appuyez sur la touche d’éjection de disque (C) pour éjecter le disque. Les lecteurs optiques 
à chargement par fente Apple ne prennent en charge que des disques circulaires de 12 cm. 
Les disques non standard et les disques n’ayant pas une forme circulaire ne fonctionnent 
pas avec le lecteur optique. Pour plus d’informations sur les disques non standard, accédez 
au site d’assistance et de service Apple à l’adresse www.apple.com/fr/support, puis recherchez «disques non standard».
Comment connecter un moniteur externe, un téléviseur ou un projecteur à mon 
MacBook ?
1 Allumez l’écran externe ou le projecteur.
2 Vérifiez que le câble de l’écran est bien relié au projecteur ou à l’écran externe.
3 Connectez le câble du moniteur à votre MacBook à l’aide du câble adéquat.
a Si vous connectez un périphérique externe via une connexion DVI, utilisez l’adaptateur 
Mini-DVI vers DVI d’Apple (vendu séparément).
bSi vous connectez un périphérique externe via une connexion VGA, utilisez l’adaptateur 
Mini-DVI vers VGA d’Apple (vendu séparément).
c Si vous connectez un périphérique externe via une connexion S-vidéo, utilisez 
l’adaptateur Mini-DVI vers Vidéo Apple (vendu séparément).
Votre MacBook détecte automatiquement le moniteur externe, le téléviseur ou 
le projecteur.
Avertissement : l’insertion d’un disque non standard peut endommager le lecteur.
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4 Réglez la résolution de l’écran externe via la fenêtre Moniteurs des Préférences Système 
ou le menu d’état Moniteurs de la barre de menus.
Pour obtenir plus d’informations sur la connexion d’écrans et autres périphériques, 
consultez «Gestion de la vidéo externe» à la page 71.
J’ai oublié mon mot de passe. Comment le réinitialiser ?
Pour réinitialiser votre mot de passe, démarrez à partir du disque d’installation de logiciels fourni avec votre ordinateur. Une fois le programme d’installation ouvert, sélectionnez Installation > «Réinitialiser le mot de passe» dans la barre des menus. Suivez 
les instructions à l’écran.
J’entends un ventilateur se déclencher et la température de mon MacBook semble 
augmenter. Est-ce normal ?
Votre MacBook est conçu pour fonctionner dans le cadre de limites thermiques sûres. Le 
ventilateur se déclenche et fonctionne pour maintenir le MacBook à des températures 
normales lorsqu’il est en activité. La partie inférieure de votre MacBook peut s’échauffer 
car elle sert à évacuer la chaleur du boîtier. Il s’agit d’un comportement tout à fait normal. 
Pour plus d’informations, consultez la section «Utilisation de votre MacBook» à la page 116.
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Une application ou Mac OS X semble ne pas fonctionner correctement. Dois-je 
réinstaller Mac OS X ?
Le processus de dépannage d’un problème demande que vous répondiez à plusieurs 
questions, notamment si le problème survient toujours avec une application spécifique, 
s’il est lié au système d’exploitation ou s’il est dû à un matériel défectueux. Avant de 
réinstaller, consultez la section «Dépannage» à la page 99 pour vous aider à analyser le 
problème. Apple fournit également de nombreuses explications et des conseils techniques de résolution de problèmes sur le site d’assistance et de service Apple, à l’adresse 
www.apple.com/fr/support. Si vous constatez qu’une réinstallation de Mac OS X 
s’impose, vous trouverez toutes les instructions nécessaires dans la section «Réinstallation 
des logiciels fournis avec votre ordinateur» à la page 106.
J’ai installé une application sur mon MacBook, mais elle ne semble pas fonctionner. 
Où trouver de l’aide ?
Vérifiez la documentation fournie avec l’application pour savoir comment obtenir de 
l’assistance. Les fabricants sont souvent conscients des problèmes courants susceptibles 
de survenir avec leurs applications et fournissent des solutions et des mises à jours à 
usage immédiat. Si votre application n’est pas un produit Apple, contactez directement 
l’éditeur concerné afin d’obtenir une assistance adaptée.
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Communications Regulation Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions: (1) 
This device may not cause harmful interference, and (2) 
this device must accept any interference received, 
including interference that may cause undesired 
operation. See instructions if interference to radio or 
television reception is suspected.
L’utilisation de ce dispositif est autorisée seulement aux 
conditions suivantes : (1) il ne doit pas produire de 
brouillage et (2) l’utilisateur du dispositif doit étre prêt à 
accepter tout brouillage radioélectrique reçu, même si 
ce brouillage est susceptible de compromettre le 
fonctionnement du dispositif.
Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed and 
used properly—that is, in strict accordance with Apple’s 
instructions—it may cause interference with radio and 
television reception. 
This equipment has been tested and found to comply 
with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These 
specifications are designed to provide reasonable 
protection against such interference in a residential 
installation. However, there is no guarantee that 
interference will not occur in a particular installation. 
You can determine whether your computer system is 
causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of 
the peripheral devices. 
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops. 
Â Move the computer to one side or the other of the 
television or radio. 
Â Move the computer farther away from the television or 
radio. 
Â Plug the computer in to an outlet that is on a different 
circuit from the television or radio. (That is, make 
certain the computer and the television or radio are on 
circuits controlled by different circuit breakers or 
fuses.) 
If necessary, consult an Apple-authorized service 
provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician for 
additional suggestions. 
Important: Changes or modifications to this product 
not authorized by Apple Computer, Inc., could void the 
EMC compliance and negate your authority to operate 
the product.
This product has demonstrated EMC compliance under 
conditions that included the use of compliant peripheral 
devices and shielded cables between system 
components. It is important that you use compliant 
peripheral devices and shielded cables between system 
components to reduce the possibility of causing 
interference to radios, television sets, and other 
electronic devices.
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Responsible party (contact for FCC matters only):
Apple Computer, Inc. Product Compliance, 
1 Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 
408-974-2000.
Wireless Radio Use
This device is restricted to indoor use due to its 
operation in the 5.15 to 5.25 GHz frequency range to 
reduce the potential for harmful interference to cochannel Mobile Satellite systems.
Cet appareil doit être utilisé à l’intérieur.
Exposure to Radio Frequency Energy
The radiated output power of the AirPort Extreme 
technology is below the FCC radio frequency exposure 
limits. Nevertheless, it is advised to use the wireless 
equipment in such a manner that the potential for 
human contact during normal operation is minimized.
FCC Bluetooth Wireless Compliance
The antenna used with this transmitter must not be 
collocated or operated in conjunction with any other 
antenna or transmitter subject to the conditions of the 
FCC Grant.
Bluetooth Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment regulations.
Cet appareil numérique de la Classe B respecte toutes 
les exigences du Règlement sur le matériel brouilleur 
du Canada.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B 
specifications. Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada. This device 
complies with RSS 210 of Industry Canada.
Bluetooth Europe–EU Declaration of Conformity
This wireless device complies with the specifications 
EN 300 328, EN 301-489, and EN 60950 following the 
provisions of the R&TTE Directive.
Europe - EU Declaration of Conformity
The equipment complies with the RF Exposure 
Requirement 1999/519/EC, Council Recommendation of 
12 July 1999 on the limitation of exposure of the general 
public to electromagnetic fields (0 Hz to 300 GHz). This 
equipment meets the following conformance standards:
EN300 328, EN301 893, EN301 489-17, EN60950
Par la présente Apple Computer, Inc. déclare que 
l’appareil 802.11a/b/g Mini-PCIe card est conforme aux 
exigences essentielles et aux autres dispositions 
pertinentes de la directive 1999/5/CE.
Complies with European Directives
72/23/EEC, 89/336/EEC, 1999/5/EC
See http://www.apple.com/euro/compliance
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Korea Statements
Singapore Wireless Certification
Taiwan Wireless Statements
Taiwan Class B Statement
VCCI Class B Statement
Informations sur les modems USB externes
Si vous connectez votre MacBook à une ligne 
téléphonique par le biais d’un modem USB externe, 
veuillez vous reporter aux informations fournies par 
l’agence de télécommunications mentionnées dans 
la documentation livrée avec votre modem. 
ENERGY STAR® Compliance
As an ENERGY STAR® partner, Apple has determined that 
standard configurations of this product meet the 
ENERGY STAR® guidelines for energy efficiency. The 
ENERGY STAR® program is a partnership with office 
product equipment manufacturers to promote energyefficiency. Reducing energy consumption of office 
products saves money and reduces pollution by 
eliminating wasted energy.
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Informations sur l’élimination et le recyclage
La lampe du rétro-éclairage interne à ce produit 
contient du mercure. Elle doit être recyclée ou traitée 
conformément à la législation locale, nationale 
et fédérale. Pour vous informer sur le programme 
de recyclage d’Apple, rendez-vous sur le site 
www.apple.com/environment/summary.html
Informations sur l’enlèvement de la batterie
Disposez des batteries conformément aux directives 
d’environnement locales en vigueur.
Deutschland: Das Gerät enthält Batterien. Diese gehören 
nicht in den Hausmüll. Sie können verbrauchte Batterien 
beim Handel oder bei den Kommunen unentgeltlich 
abgeben. Um Kurzschlüsse zu vermeiden, kleben Sie die 
Pole der Batterien vorsorglich mit einem Klebestreifen 
ab.
Nederlands:Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) worden 
gedeponeerd.
Taïwan:
Union européenne—instructions concernant 
l’élimination des déchets :
Le symbole ci-dessus signifie que vous devez vous 
débarrasser de votre produit sans le mélanger avec les 
ordures ménagères, selon les normes et la législation 
de votre pays. Lorsque ce produit n’est plus utilisable, 
portez-le dans un centre de traitement des déchets 
agréé par les autorités locales. Certains centres 
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Préface
Documentation et ressources 
relatives à Motion 3
Grâce à Motion, vous allez être en mesure de créer des contenus 
graphiques animés élaborés que vous pourrez intégrer à 
des programmes à diffuser ou à de vidéos. Découvrez toutes 
les ressources à votre disposition pour apprendre à utiliser 
cette application polyvalente.
Cette préface fournit des informations sur la documentation disponible au sujet 
de Motion, ainsi que sur les ressources Motion accessibles sur le web. 
Aide en ligne
L’aide en ligne (accessible via le menu Aide) offre un accès simple à diverses informations alors que vous êtes en train de travailler dans Motion. Elle met à votre disposition 
un certain nombre de documents, comme le Manuel de l’utilisateur Motion 3 et d’autres 
documents au format PDF et HTML, dont la Documentation supplémentaire de Motion 
qui contient des informations détaillées sur le compositing 3D et les comportements 
Suivi de l’animation.
Pour accéder à l’aide en ligne :
m Dans Motion, choisissez l’une des options proposées par le menu Aide.
Manuel de l’utilisateur
Le Manuel de l’utilisateur Motion 3 contient des informations détaillées sur la majorité 
des fonctionnalités de l’application.
Pour accéder à ce manuel de l’utilisateur :
m Dans Motion, choisissez Aide > Manuel de l’utilisateur Motion.
À l’ouverture du Manuel de l’utilisateur Motion 3, vous accédez directement à une page 
d’accès. Le tiroir Preview sur le côté contient une liste de signets servant à localiser des 
informations spécifiques dans le manuel de l’utilisateur. Cliquez sur l’un de ces signets 
pour commencer à explorer le manuel de l’utilisateur. 10 Préface Documentation et ressources relatives à Motion 3
Les liens dans le corps de la page d’accès offrent un moyen supplémentaire de localiser 
de nombreuses sources d’aide et d’autres outils de documentation vous permettant 
d’apprendre à utiliser Motion. La plupart de ces liens sont également disponibles 
directement à partir du menu Aide :
Documentation supplémentaire
Disponible au format PDF, la Documentation supplémentaire de Motion contient des 
informations sur le compositing 3D, notamment l’espace de travail 3D, les lumières, les 
caméras et leurs comportements, ainsi que le tramage. Cette documentation traite également de l’utilisation des comportements Suivi de l’animation. 
Pour accéder à la documentation supplémentaire, procédez de l’une des manières 
suivantes :
m Dans Motion, choisissez Aide > 3D et suivi
m Accédez à http://manuals.info.apple.com/fr/Motion_Supplemental_Documentation.pdf
Notes sur la version
Le document Notes sur la version contient des informations sur les problèmes concernant le matériel et les logiciels tiers, ainsi que les dysfonctionnements connus. Il comporte également des informations sur les nouvelles fonctionnalités et les modifications 
apportées au logiciel après la finalisation du Manuel de l’utilisateur Motion 3. 
Pour accéder au document Notes sur la version :
m Dans Motion, choisissez Aide > Notes sur la version.
Nouvelles fonctionnalités
Le document Nouvelles fonctionnalités décrit brièvement les nouveautés de la dernière 
version de Motion et explique l’emplacement des informations détaillées sur ses fonctionnalités dans le manuel de l’utilisateur ou la Documentation supplémentaire de 
Motion.
Pour accéder au document Nouvelles fonctionnalités :
m Dans Motion, choisissez Aide > Nouvelles fonctionnalités.Préface Documentation et ressources relatives à Motion 3 11
Sites web Apple
Il existe une multitude de forums de discussion et de sources d’informations relatifs 
à Motion sur Internet.
Sites web Motion
Les sites web suivants fournissent des informations d’ordre général, des mises à jours, 
des conseils et de l’assistance sur Motion, ainsi que les nouveautés, les ressources 
et les supports de formation les plus récents.
Pour en savoir plus sur Motion, visitez le site : 
Â http://www.apple.com/fr/finalcutstudio/motion
Pour davantage d’informations sur les outils tiers, les ressources et les groupes 
d’utilisateurs, accédez au site :
Â http://www.apple.com/fr/finalcutstudio/resources
Pour des informations sur le programme Apple intitulé Pro Training, visitez le site :
Â http://www.apple.com/software/pro/training (en anglais)
Pour transmettre à Apple vos commentaires sur Motion, accédez au site :
Â http://www.apple.com/fr/feedback/motion.html 
Site Web d’assistance et de support d’Apple
Le site web d’assistance et de support d’Apple met à votre disposition les dernières mises 
à jour logicielles et vous fournit des réponses aux questions les plus fréquentes au sujet 
des produits Apple, y compris Motion. Vous y avez également accès aux spécifications des 
produits, aux documentations de référence et à des articles techniques d’Apple et de 
tierce partie :
Â http://www.apple.com/fr/support1
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1 Premiers contacts avec Motion
Ce chapitre présente les concepts de base de l’animation 
ainsi que l’interface de Motion. Il décrit également la manière 
d’utiliser l’ensemble des outils élémentaires nécessaires 
pour commencer.
Motion est une application d’animation graphique basée sur des « comportements » 
qui vous permettent de créer des effets étonnants dans une grande variété de projets, 
notamment les séquences de générique, les graphismes diffusés et les simulations 
élaborées. 
Grâce à Motion, vous pouvez créer des mouvements et une multitude d’autres effets 
à la volée et en temps réel. Faites simplement glisser l’un des comportements (comme 
Rotation ou Lancer) ou l’un des filtres (comme Éclat ou Stoboscope) fournis avec Motion 
sur un objet dans le Canevas, puis observez votre composition prendre vie sous vos 
yeux, avec des tourbillons, des glissades sur l’écran, des pulsations luminescentes ou des 
centaines d’autres effets. 
Vous pouvez bien sûr recourir à une technique d’animation plus classique, à l’aide 
d’images clés, mais les comportements de Motion vous offrent une réponse instantanée. 
Il ne vous reste donc plus qu’à vous asseoir avec vos clients, vos directeurs artistiques 
ou vos amis et à concevoir de manière interactive votre projet d’animation. Vous avez 
envie qu’un titre s’estompe, oscille légèrement, puis glisse hors du champ ? Cliquez 
tout simplement sur le bouton de lecture, puis faites glisser les comportements Fondu, 
Animation aléatoire et Gravité sur le titre en question dans le Canevas. Inutile d’attendre 
le rendu pour prévisualiser l’effet obtenu !14 Chapitre 1 Premiers contacts avec Motion
Motion peut aussi bien servir à créer des publicités, des documentaires, des génériques, 
des émissions, des graphiques Internet, des présentations d’entreprise, des menus 
de DVD, que vos propres projets vidéo. Que vous ayez besoin de la précision de l’animation par images clés, du flux plus libre des effets animés des comportements ou 
des deux, Motion dispose de tous les outils nécessaires pour répondre à vos besoins.
Ce chapitre contient une introduction à l’animation graphique et à l’espace de travail 
de Motion, ainsi que des instructions relatives à la navigation et à l’utilisation des outils 
et des commandes les plus courants.
À propos de l’animation graphique
L’animation graphique est un type de création d’effets visuels généralement associé 
aux séquences de générique et d’introduction des émissions, aux coupures et aux 
publicités interstitielles, ainsi qu’à la conception d’interfaces telles que les menus des DVD. 
L’animation graphique est également fréquemment utilisée dans les environnements 
techniques pour créer des simulations de systèmes mobiles tels que les modèles 
de circulation ou les modèles scientifiques.
Elle incorpore habituellement plusieurs objets simultanés à l’écran et repose généralement 
sur des considérations liées à la création et à un sens aigu de l’impact visuel. Les graphistes 
les plus sophistiqués associent souvent des techniques de dessin et de présentation traditionnelles à des outils empruntés au domaine des effets spéciaux, tels que l’incrustation, 
les masques, le mixage et les systèmes de particules, afin de créer des œuvres animées 
dynamiques. Les outils utilisés habituellement pour l’animation graphique sont répartis
en trois catégories.
Outils de création
Les graphistes utilisent depuis de nombreuses années des logiciels qui leur facilitent 
le travail. Motion intègre donc plusieurs des outils les plus intéressants et les plus couramment utilisés dans les applications de PAO et de conception, notamment les guides, 
l’alignement et la manipulation directe pour le positionnement, la transformation et 
la déformation de couches. Il contient également quelques-uns des outils les plus 
souples et les plus sophistiqués pour la création et la gestion d’éléments de texte. 
Cela s’avère particulièrement important car le texte constitue un élément critique 
de la création d’animations graphiques.Chapitre 1 Premiers contacts avec Motion 15
Outils de contrôle du temps
La différence principale entre la création traditionnelle et l’animation graphique, c’est 
le contrôle du temps. Cela signifie que vous devez non seulement créer une maquette 
lisible et bien composée, mais également manipuler cette maquette tout au long de 
la durée de votre création. Motion fournit une Timeline qui contient des outils généralement disponibles dans les applications de montage vidéo (tels que le Trim, les marqueurs, 
le coulissement et le magnétisme) pour vous aider à affiner et composer les aspects 
temporels de votre projet. 
Motion gère également les fichiers audio, y compris le mixage audio de base, ce qui 
vous permet de créer une bande-son pour votre projet et de prendre des décisions 
en matière de contrôle du temps en fonction non seulement des éléments visuels, 
mais également des éléments sonores. Vous pouvez animer des couches, des filtres, 
des comportements et d’autres éléments, afin de créer des compositions élégantes 
et précises. Qui plus est, vous avez la possibilité de resynchroniser une séquence à l’aide 
de la technologie du flux optique ou d’appliquer des comportements Resynchronisation 
à des plans pour obtenir des effets très funky, tels que des images cadencées ou éclairées. 
Compositing 2D et 3D
Dès que votre projet implique la présence simultanée de plusieurs couches à l’écran, vous 
devez utiliser une méthode de compositing pour combiner ces éléments. Vous êtes alors 
amené à déplacer des couches à l’écran pour éviter qu’elles ne se chevauchent, régler 
leur opacité pour les rendre partiellement visibles ou incorporer des modes de fusion 
permettant divers mixages des images superposées. Le compositing constitue un aspect 
fondamental du travail d’animation graphique. Heureusement, Motion est là pour vous 
simplifier la vie comme jamais : vous avez la possibilité de contrôler l’ordre des couches et 
des groupes, de verrouiller les couches de certains groupes, ainsi que d’appliquer plus de 
25 options de fusion, et d’obtenir ainsi des effets hors de commun.
Vous pouvez également combiner des groupes 2D et 3D au sein d’un même projet, 
ce qui vous autorise un compositing standard sur certains éléments et des animations 3D 
complexes sur d’autres.
Outils d’effets spéciaux
Vous pouvez améliorer vos projets d’animation graphique en utilisant de nombreux outils 
identiques à ceux utilisés au cinéma afin de combiner, par exemple, des dinosaures et des 
acteurs vivants, faire couler des navires de croisière ou créer des batailles spatiales. Motion 
est doté de plusieurs de ces outils, notamment l’incrustation (pour isoler le plan d’un objet 
sur un arrière-plan de couleur unie), les masques (pour masquer des câbles ou d’autres 
objets qui ne doivent pas apparaître sur l’image finale) et les systèmes de particules (pour 
simuler des phénomènes naturels, comme la fumée, le feu ou l’eau). Motion peut, de fait, 
être utilisé pour créer ce genre d’effets spéciaux, mais sa puissance réelle provient du fait 
qu’il intègre ces outils aux outils de création et de montage décrits plus haut.16 Chapitre 1 Premiers contacts avec Motion
Outils uniques
Les différents jeux d’outils disponibles dans les applications les plus courantes se 
sont développés au fur et à mesure de l’évolution de l’animation graphique. Motion 
adopte toutefois une approche totalement inédite pour ce genre de tâche. Il incorpore le dernier cri en matière de logiciels de création tout en exploitant pleinement 
la puissance du matériel Apple le plus récent. Bien qu’il comprenne les outils et les 
techniques auxquels les artistes se sont accoutumés, il intègre également un nouvel 
ensemble d’outils appelés comportements qui simplifient les procédures auparavant 
complexes (voire quasi impossibles) et les rendent aussi simples qu’un glisser-déposer. Un outil appelé réplicateur permet même de créer un motif personnalisé à partir 
de copies d’une couche, générant ainsi très rapidement des effets de conception 
complexes qui nécessiteraient des heures dans d’autres applications. D’autres outils 
doués d’une très grande flexibilité, pour le dessin et les formes, vous permettent également d’ajouter et de créer des formes tracées au fil du temps dans le Canevas.
Comportements
Les comportements proposés dans Motion simplifient les tâches les plus courantes, telles 
que la mise à l’échelle, les fondus et les déplacements d’éléments. Ils vous permettent également de créer des interactions 2D ou 3D d’une grande complexité, comme des effets du 
type Collision sur les bords (pour faire rebondir des éléments sur les bords que vous avez 
indiqués) ou Attracteur (pour donner à un élément une force d’attraction gravitationnelle 
sur les éléments avoisinants). D’autre part, le texte revêtant une telle importance dans les 
animations graphiques, Motion inclut plus de 100 comportements spécialement conçus 
pour les éléments de texte, capables de traiter chaque lettre individuellement tout en 
affectant l’ensemble de la couche correspondante.
Grâce aux comportements Simulation, les textes, particules, éléments du motif 
d’un réplicateur et touches d’un trait de peinture peuvent être extraits du plan 
bidimensionnel, puis attirés par une couche présentant un décalage sur l’axe Z.
Palette
Devoir rechercher sans cesse l’emplacement de réglages particuliers est un problème 
qui peut perturber considérablement le déroulement de votre travail. Motion utilise une 
fenêtre flottante spéciale, appelée la palette, qui vous offre un accès immédiat aux paramètres que vous utilisez le plus fréquemment. La palette est mise à jour de façon dynamique en fonction de l’élément sélectionné. Elle seule vous permet d’ailleurs d’accéder 
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La palette vous assure également la possibilité d’ajouter rapidement des comportements à des paramètres particuliers d’un objet. Ces comportements Paramètre vous 
permettent d’affecter un seul aspect d’un objet (sa position, son échelle ou son opacité, 
par exemple), sans modifier l’objet dans son ensemble. Pour ce faire, cliquez sur un 
paramètre dans la palette tout en maintenant la touche Contrôle enfoncée, puis choisissez un comportement Paramètre dans le menu local. Pour en savoir plus sur les comportements Paramètre, voir « Application de comportements Paramètre » à la page 417.
Réponse en temps réel
Moyennant une configuration matérielle adéquate, sachez que vous avez la possibilité 
de visualiser en temps réel la plupart des effets et des réglages que vous effectuez. 
En d’autres termes, vous pouvez observer les interactions entre les différents éléments 
de votre composition au fur et à mesure de vos modifications. Vous bénéficiez non seulement de la réduction du délai nécessaire à votre ordinateur pour convertir vos actions 
(clics, glisser-déposer, etc.) en un film regardable, mais vous êtes en mesure d’interagir 
avec votre création de manière plus fluide et agréable. Plutôt que d’élaborer de multiples hypothèses, puis d’attendre de voir comment elles se concrétisent, vous pouvez 
désormais vérifier immédiatement la manière dont vos idées se réalisent et effectuer 
instantanément des modifications. 
Cette réponse en temps réel transforme la création d’une séquence d’animation graphique en un processus d’exploration et de découverte, plus conforme à la manière dont 
la plupart des artistes préfèrent travailler. Motion n’offre pas seulement un nouvel 
ensemble de pinceaux pour le concepteur d’animation, mais plutôt un type totalement 
nouveau d’environnement de travail. 18 Chapitre 1 Premiers contacts avec Motion
Remarques relatives à l’utilisation de la souris et aux raccourcis clavier
Si vous disposez d’une souris à trois boutons, il vous suffit de cliquer à l’aide du bouton 
droit pour accéder aux commandes indiquées dans ce manuel de l’utilisateur via la 
combinaison clic + touche Contrôle enfoncée (par exemple : cliquez sur la barre d’outils 
tout en maintenant la touche Contrôle enfoncée, puis choisissez Personnaliser la barre 
d’outils dans le menu local). Si vous travaillez sur un PowerBook G4, un MacBook ou 
un MacBook Pro, gardez à l’esprit que certains raccourcis clavier nécessitent d’utiliser 
la touche Fonction (fn, à côté de la touche Contrôle) en plus des touches mentionnées 
dans ce manuel. Par exemple, vous devez utiliser la touche Fonction en combinaison 
avec les touches F1 à F10, ainsi que de nombreuses lettres, pour activer certains raccourcis 
clavier, comme le signe plus (+), moins (–), etc. Pour en savoir plus sur les raccourcis 
clavier dans Motion, voir l’annexe A, « Raccourcis clavier », à la page 1255. 
À propos de Motion
Dans Motion, vous avez la possibilité de créer des graphismes animés et des projets 
de compositing 2D ou 3D à partir d’images importées (comme des fichiers Adobe 
Photoshop ou Illustrator), de séquences d’images, séquences QuickTime, fichiers audio, 
ainsi que d’objets créés dans Motion. Le texte, les masques, les formes, les particules, 
les traits de peinture, etc. figurent au nombre de ces objets.
Activation des touches de fonction habituelles sur les ordinateurs 
portables Macintosh
Sur un Powerbook, un MacBook ou un MacBook Pro, les touches F1 à F12 sont par 
défaut affectées aux contrôles matériels, tels que la luminosité, le volume audio, 
le verrouillage numérique, etc. Vous devez donc appuyer sur la touche Fonction (Fn) 
en plus de la touche de fonction indiquée, si vous souhaitez activer une commande 
associée à une touche de fonction dans vos applications.
Vous pouvez modifier les préférences relatives à votre clavier, afin que les touches 
de fonction fonctionnent normalement, sans avoir à appuyer sur la touche Fn. Si 
vous avez décidé d’activer cette option, appuyez sur la touche Fn en plus d’une des 
touches de fonction pour exécuter les contrôles matériels.
Pour activer les touches de fonction habituelles :
m Sous l’onglet Clavier des préférences Clavier et souris dans les Préférences Système, 
cochez la case « Utiliser les touches F1-F12 pour contrôler les fonctions logicielles ». 
Il vous suffit de la désactiver pour restaurer le réglage par défaut.Chapitre 1 Premiers contacts avec Motion 19
Un projet Motion est constitué de groupes contenant une ou plusieurs couches. 
D’ailleurs, tous les médias importés dans Motion ou les éléments créés dans un projet 
sont considérés comme des couches. Toute couche doit être placée au sein d’un groupe. 
Le groupe tient le rôle de « parent » vis-à-vis des couches qu’il contient. Vous pouvez 
sélectionner plusieurs couches d’un groupe pour créer un groupe imbriqué. Un groupe 
peut être défini en 2D ou en 3D. 
Il est possible d’ajouter des caméras et des tables lumineuses aux projets. Si vous ajoutez 
une caméra à un projet, vous avez la possibilité de basculer le projet en mode 3D ou 
de le conserver en mode 2D (à moins que le projet ne soit vide ou entièrement en 2D, 
auquel cas il est automatiquement basculé en 3D). Tout groupe 3D peut contenir des 
groupes 2D. Un groupe 2D peut même être imbriqué dans un groupe 3D et inversement. 
Néanmoins, si vous imbriquez un groupe 3D dans un groupe 2D, il est aplati, ce qui signifie 
que le groupe 3D incorporé se comporte comme un objet plat et qu’il ignore la caméra. 
Qui plus est, le groupe aplati ne croise plus les couches du groupe 2D ou d’autres 
groupes au sein du projet.
Les transformations, filtres ou comportements appliqués à un groupe sont également 
appliqués aux couches situées dans ce groupe. Si vous déplacez ou appliquez un filtre 
ou un comportement à un groupe, toutes les couches de ce groupe sont donc affectées. 
Vous pouvez également appliquer des filtres et des comportements à des couches particulières au sein d’un groupe.
Un filtre est en fait un processus qui modifie l’apparence d’une image. Un filtre Flou, 
par exemple, utilise une image d’entrée et génère une version floue de cette image. 
Un comportement est un processus qui applique une plage de valeurs aux paramètres 
d’un objet, afin de créer une animation à partir des paramètres affectés. Le comportement Rotation fait par exemple pivoter un objet au fil du temps, à une vitesse définie 
par vos soins.
Groupes et couches peuvent être déplacés et animés à l’aide de comportements 
ou d’images clés. Quant aux filtres, ils peuvent également être animés.
Un projet représente un seul et même flux de données graphiques, établi de bas en haut. 
Dans un montage composite constitué d’un seul groupe, les couches de ce groupe sont 
empilées les unes sur les autres. Les filtres et les comportements appliqués à une couche 
apparaissent en dessous de cet objet dans la liste de couches. Le groupe est l’image combinée obtenue à partir des couches et des comportements, filtres et modes composites 
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Pour utiliser un exemple simple, prenons un groupe contenant une seule image à laquelle 
sont appliqués les filtres Étalonnage et Flou (dans cet ordre). L’image fournit les données 
d’entrée au filtre Étalonnage. Les données de sortie de ce filtre constituent les données 
d’entrée du filtre Flou. Au final, le groupe correspond au résultat de ce flux de données 
graphiques. Groupes et couches sont également empilés les uns sur les autres au sein 
d’un projet : les données de sortie de la couche située tout en bas de la pile sont les données d’entrée de la couche située au-dessus dans la pile, et ainsi de suite.
Lorsque vous travaillez en 3D, une couche située en dessous d’une autre dans la liste 
de couches peut cependant apparaître au-dessus dans le Canevas, si sa position Z est 
plus proche de la caméra. Vous pouvez forcer les couches à respecter l’ordre de la liste 
de couches en activant l’option Ordre de couche dans l’onglet Groupe de l’Inspecteur.
À propos de l’espace de travail de Motion
Lorsque vous ouvrez Motion, l’espace de travail remplit tout votre écran, mais l’interface 
est en réalité constituée de plusieurs fenêtres indépendantes. Il est possible de modifier 
les dimensions et les dispositions de ces fenêtres afin de les adapter aux exigences des 
différents projets. Il est possible d’afficher d’autres fenêtres en plus de celles par défaut. 
L’illustration suivante représente la disposition Cinéma.
Fenêtre Utilitaire Canevas (au-dessus de la fenêtre 
Contrôle du temps)
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Fenêtre Utilitaire
À l’ouverture de Motion, une fenêtre Utilitaire apparaît à gauche de l’écran. Elle contient 
le Navigateur à partir duquel vous pouvez ajouter des fichiers à votre projet. Elle comporte 
également des onglets pour afficher la Bibliothèque (qui comprend tous les effets, 
les modèles et d’autres éléments utiles fournis avec Motion) et l’Inspecteur, dans lequel 
vous pouvez ajuster les réglages de ces effets.
Remarque : en présentation Cinéma, l’onglet Inspecteur est affiché dans une fenêtre 
Utilitaire séparée, située à droite de l’espace de travail.
Navigateur
Bibliothèque
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Canevas
La majorité de l’écran est occupée par votre zone de travail principale, le Canevas. 
Cette zone est similaire à la fenêtre de document que l’on trouve dans de nombreuses 
autres applications. Le Canevas vous sert à organiser et à présenter les couches qui 
constituent votre composition. Pour ajouter des couches et des effets à votre projet, 
il vous suffit de les faire glisser depuis la fenêtre Utilitaire vers le Canevas.
Lorsque vous souhaitez lire votre projet, les commandes de lecture en bas de cette 
fenêtre (en dessous du Canevas) vous permettent d’effectuer la lecture à vitesse normale 
ou image par image. La mini-Timeline se situe juste au-dessus des commandes de lecture 
et sous la partie principale de la fenêtre. Elle indique les points de départ et de fin 
(dans le temps) des couches sélectionnées dans le Canevas.
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Menu contextuel du Canevas
Le Canevas dispose de son propre menu contextuel. Il vous permet d’accéder à certains 
outils nécessaires à votre travail dans le Canevas. 
Pour utiliser le menu contextuel du Canevas :
m Cliquez sur une zone vierge du Canevas tout en maintenant la touche Contrôle enfoncée 
(une zone grise en dehors du projet en cours), puis choisissez une option dans la liste 
affichée :
Â Nouveau groupe : ajoute un nouveau groupe au projet, au-dessus de tous 
les groupes présents dans l’onglet Couches.
Â Importer : ouvre la zone de dialogue Importation, qui vous permet d’importer 
des fichiers à partir du Finder.
Â Coller: colle tout élément (précédemment copié dans le Presse-papiers) dans 
un nouveau groupe du projet. Ce nouveau groupe est ajouté au-dessus de tous 
les groupes présents dans l’onglet Couches.
Â Propriétés du projet : ouvre la zone de dialogue du même nom, qui vous permet 
de modifier la couleur d’arrière-plan, les proportions, le rendu de trames, le flou 
d’animation, etc. du projet. Pour en savoir plus sur les propriétés du projet, voir 
« Création de projets vierges à partir de préréglages de projet » à la page 201.
Le Canevas contient également deux fenêtres supplémentaires qui ne sont pas 
affichées par défaut.
Sous-fenêtre Projet
La sous-fenêtre Projet contient trois onglets donnant chacun accès à différents aspects 
de votre projet. L’onglet Couches affiche la hiérarchie des objets (groupes, couches, 
caméras, lumières, comportements, filtres, etc.) contenus dans votre projet. L’onglet Média 
affiche tous les fichiers importés dans votre projet, avec une option vous permettant 
d’indiquer si vous souhaitez visualiser le média correspondant, qu’il apparaisse ou non 
dans le Canevas. Quant à l’onglet Audio, il vous donne accès aux fichiers audio de votre 
projet et vous permet de les contrôler. Tous ces onglets sont décrits de manière plus 
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Fenêtre Contrôle du temps
La fenêtre Contrôle du temps comporte également trois onglets, chacun contrôlant 
un aspect particulier de votre projet. L’onglet Timeline offre une vue d’ensemble de 
tous les objets et de leur disposition dans le temps. L’onglet Éditeur d’images clés affiche 
les courbes d’animation des paramètres animés et des effets, alors que l’onglet Audio 
affiche les commandes de réglage des niveaux et de la balance des éléments audio 
de votre projet. 
Tous ces onglets sont décrits de manière plus détaillée plus loin dans ce chapitre 
et tout au long de ce manuel.
Sous-fenêtre Projet
Fenêtre Contrôle
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Présentation des fenêtres
Chaque flux de travaux requiert l’affichage d’un ensemble particulier de fenêtres, 
dans des tailles différentes. Ainsi, la création d’une maquette de composition requiert 
un grand Canevas, tandis que la mise au point et le réglage final d’un effet animé 
nécessitent plus d’espace pour la fenêtre Contrôle du temps et l’Inspecteur. Dans 
Motion, vous pouvez passer rapidement d’un mode de présentation à l’autre, voire 
enregistrer vos modes de présentation personnalisés.
Présentations prédéfinies
Motion propose trois dispositions de fenêtres prédéfinies, encore appelées présentations. 
Ces présentations répartissent les fenêtres de l’application de diverses manières 
en fonction du type de flux de travaux. 
Pour choisir une présentation de fenêtre prédéfinie :
m Choisissez Fenêtre > Présentations, puis sélectionnez une présentation dans 
le sous-menu.
Présentation Standard : affiche la fenêtre Utilitaire à gauche et le Canevas à droite. 26 Chapitre 1 Premiers contacts avec Motion
Présentation Alternative : affiche deux fenêtres Utilitaire à gauche : la fenêtre 
supérieure contient l’Inspecteur et la fenêtre inférieure contient le Navigateur 
et la Bibliothèque. Le Canevas occupe le reste de l’écran à droite. 
Présentation Cinéma : elle affiche également deux fenêtres Utilitaire. La fenêtre 
à gauche de l’espace de travail gauche contient le Navigateur et la Bibliothèque, 
alors que la fenêtre de droite contient l’Inspecteur. Le Canevas se trouve au milieu, 
la sous-fenêtre Projet et la fenêtre Contrôle du temps étant également affichées. 
Pour utiliser la présentation Cinéma, la résolution minimale de votre écran en largeur 
doit être égale à 1 325. Chapitre 1 Premiers contacts avec Motion 27
Commandes de fenêtre élémentaires
Outre la possibilité de choisir parmi plusieurs dispositions prédéfinies, vous avez 
également la possibilité d’arranger manuellement vos fenêtres, de les redimensionner 
ou de les envoyer dans le Dock.
Pour déplacer une fenêtre :
m Cliquez sur la barre de titre de la fenêtre, puis faites-la glisser vers un nouvel emplacement.
Pour redimensionner une fenêtre :
m Faites glisser la commande de redimensionnement qui se trouve dans l’angle inférieur 
droit de la fenêtre, afin de donner à cette dernière la taille souhaitée.
Pour redimensionner simultanément plusieurs fenêtres adjacentes :
m Faites glisser la limite entre les deux fenêtres (la ligne noire le long du bord de 
la fenêtre). Le pointeur change de forme lorsque vous placez le curseur sur la limite, 
vous permettant ainsi de redimensionner les deux fenêtres.
Pour placer une fenêtre dans le Dock :
m Cliquez sur le bouton de réduction qui se trouve dans la barre de titre. Vous pouvez 
également double-cliquer sur la barre de titre du Canevas afin de le placer dans le Dock.
Remarque : il est impossible de placer les fenêtres Utilitaire dans le Dock.
Pour fermer une fenêtre, procédez de l’une des manières suivantes :
m Cliquez sur le bouton de fermeture.
m Appuyez sur les touches Commande + W dans une fenêtre active.
Faites glisser la ligne 
noire fine entre les 
deux fenêtres afin de 
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Onglets
Motion utilise des fenêtres à onglets pour fournir un accès simple et direct à diverses 
fenêtres. Vous pouvez passer d’une fenêtre à l’autre en cliquant simplement sur l’onglet 
correspondant. Vous pouvez en outre faire glisser les onglets hors de leur position 
d’ancrage pour afficher la fenêtre correspondante dans une fenêtre séparée. Vous pouvez 
également faire glisser un onglet dans une autre fenêtre. Cela vous permet de visualiser 
simultanément plusieurs fenêtres à onglets provenant d’un même groupe. Vous pouvez, 
par exemple, faire glisser l’onglet Inspecteur vers un nouvel emplacement afin de visualiser 
simultanément les fenêtres Bibliothèque et Inspecteur.
Pour détacher un onglet:
m Faites glisser l’onglet hors de sa position d’ancrage vers un nouvel emplacement.
L’onglet se transforme en fenêtre autonome dès que vous relâchez le bouton de la souris. 
Vous pouvez alors utiliser toutes les commandes de fenêtre standard telles que fermer, 
réduire et redimensionner.
Pour rattacher un onglet:
m Faites glisser l’onglet en haut de la fenêtre dans son emplacement initial. Par exemple, 
faites glisser l’onglet Inspecteur jusque dans son groupe d’onglets initial, puis relâchez 
le bouton de la souris.
L’onglet est alors rattaché. 
Pour afficher ou masquer un onglet:
m Dans le menu Fenêtre, choisissez le nom de l’onglet à afficher ou à masquer. Par exemple, 
choisissez Fenêtre > Timeline pour afficher ou masquer l’onglet Timeline. Vous pouvez 
également choisir Éditeur d’images clés ou Éditeur audio pour afficher ou masquer 
ces onglets.
Si l’onglet est détaché de la zone de la Timeline, cliquez sur le bouton de fermeture. 
La fenêtre se ferme et ne réapparaît pas sous la forme d’un onglet. Pour afficher 
à nouveau la fenêtre, utilisez le menu Fenêtre, puis choisissez la commande adéquate 
pour afficher la fenêtre souhaitée.
Pour réorganiser les onglets :
m Faites glisser un onglet vers la gauche ou la droite dans la zone des onglets pour réordonner ces derniers.Chapitre 1 Premiers contacts avec Motion 29
Interversion de la sous-fenêtre Projet et du Canevas
De même qu’il est possible de modifier l’ordre des onglets, il est également possible 
de déterminer si la sous-fenêtre Projet doit être affichée à gauche du Canevas (position 
par défaut) ou à droite. Cela peut s’avérer particulièrement utile lorsque vous travaillez 
sur plusieurs écrans. Si, par exemple, le Canevas occupe la totalité de l’écran de gauche 
et vos fenêtres Utilitaire se trouvent sur l’écran de droite, le déplacement de la sousfenêtre Projet à droite du Canevas permettrait de la rapprocher des fenêtres Utilitaire.
Pour placer la sous-fenêtre Projet de l’autre côté du Canevas :
m Choisissez Fenêtre > Présentations > Intervertir la fenêtre du projet et le Canevas.
Enregistrement de présentations personnalisées
Après avoir disposé vos fenêtres selon vos besoins, vous pouvez enregistrer la présentation 
de l’écran en lui attribuant un titre significatif qui vous aidera à la retrouver plus tard. 
Cette procédure vous permet de configurer aisément des présentations qui vous aideront 
à réaliser des tâches spécifiques. Vous pourriez par exemple configurer une présentation 
adaptée au montage des courbes, tandis qu’une autre présentation pourrait contenir 
une Timeline étendue pour le montage des images clés. Vous pouvez changer de pré-
sentation via le sous-menu Présentations ou supprimer et dupliquer des présentations 
via la fenêtre Gérer les présentations.
Lorsque vous enregistrez une présentation, les éléments suivants sont enregistrés :
Â La position des fenêtres (taille et emplacement)
Â L’ordre des colonnes (dans la fenêtre du projet)
Â La position de la fenêtre du projet (à gauche ou à droite)
Remarque : l’ordre des onglets ainsi que les options d’affichage de la Timeline 
et du Canevas ne sont pas enregistrés dans la présentation personnalisée.
Pour enregistrer une présentation :
1 Disposez les fenêtres à l’écran comme vous le souhaitez.
2 Choisissez Fenêtre > Enregistrer la présentation actuelle. 
La zone de dialogue Créer une présentation de fenêtre apparaît.
3 Tapez le nom sous lequel vous souhaitez enregistrer la présentation, puis cliquez 
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La présentation est enregistrée et apparaît dans le sous-menu Présentations.
Vous pouvez également créer une nouvelle présentation personnalisée (à partir de 
la présentation en cours) en cliquant sur le bouton Ajouter (+) dans la zone de dialogue 
Gérer les présentations.
Pour activer une présentation personnalisée enregistrée :
m Choisissez Fenêtres > Présentations, puis choisissez la présentation personnalisée 
dans le sous-menu.
La nouvelle présentation apparaît dans la partie inférieure du 
sous-menu.Chapitre 1 Premiers contacts avec Motion 31
Pour supprimer une présentation personnalisée :
1 Choisissez Fenêtre > Gérer les présentations. 
La zone de dialogue Gérer les présentations s’ouvre.
2 Sélectionnez la présentation à supprimer.
3 Cliquez sur le bouton Supprimer (–) afin de supprimer l’élément de la liste. 
4 Cliquez sur le bouton Terminé.
Pour dupliquer une présentation :
1 Choisissez Fenêtre > Gérer les présentations. 
La zone de dialogue Gérer les présentations s’ouvre.
2 Sélectionnez la présentation à dupliquer.
3 Cliquez sur le bouton Dupliquer. 
Une copie de la présentation est ajoutée à la liste. Le mot « copie » est ajouté au nom.
4 Cliquez sur Terminé.
Pour renommer une présentation dans la liste :
1 Choisissez Fenêtre > Gérer les présentations. 
La zone de dialogue Gérer les présentations s’ouvre.
2 Double-cliquez sur la présentation à renommer dans la liste. 
Le nom se transforme en champ.
3 Tapez le nouveau nom dans ce champ.
4 Cliquez sur Terminé.
Mode plein écran
Motion possède une option qui permet au Canevas d’occuper la totalité de l’espace de 
votre écran. Cette option est utile si vous voulez visionner votre projet sans être distrait 
par l’interface du logiciel. Dans ce mode, tous les outils et toutes les commandes en 
rapport avec le Canevas demeurent actifs, mais vous devez utiliser les raccourcis clavier 
et les menus contextuels (clic + Contrôle) pour passer d’un outil ou d’une commande 
à l’autre. Vous pouvez accéder à la barre des menus en plaçant votre pointeur en haut 
de l’écran, à l’endroit où se trouvent habituellement les menus. 
Pour passer en mode plein écran, procédez de l’une des manières suivantes :
m Choisissez Présentation > Mode plein écran.
m Appuyez sur la touche F8.
Pour revenir en mode d’affichage normal, procédez de l’une des manières suivantes :
m Placez votre pointeur au-dessus du menu, puis choisissez à nouveau Présentation > 
Mode plein écran.
m Appuyez à nouveau sur la touche F8.32 Chapitre 1 Premiers contacts avec Motion
Barre d’outils
La barre d’outils de Motion est située en haut de la fenêtre principale. L’ensemble 
de commandes par défaut donne accès à tous les outils nécessaires pour manipuler 
des objets dans le Canevas et dans le reste de l’application. Elle comporte des outils 
destinés à créer de nouvelles couches de texte ou de forme, ainsi que des masques. 
Elle affiche également des icônes servant à appliquer des filtres et des comportements, 
voire à créer des systèmes de particules et des réplicateurs. Enfin, certaines icônes 
permettent d’afficher et de masquer les fenêtres de l’interface de Motion, telles que 
la Timeline, la palette et bien d’autres encore.
Groupes d’outils
Les outils sont regroupés de différentes manières. En effet, plusieurs possèdent des 
modes ou des options variés. C’est le cas notamment des outils Forme, qui peuvent 
êtres réglés sur Rectangle, Cercle ou Ligne. Les outils Cercle et Ligne sont masqués 
tant que vous n’avez pas cliqué sur l’outil Rectangle tout en maintenant le bouton de 
la souris enfoncé. Les outils dotés d’états supplémentaires sont signalés par une petite 
flèche pointant vers le bas dans l’angle inférieur droit. 
Les outils sont également regroupés par catégories d’utilisation. La première catégorie 
d’outils est appelée Présentation, car elle regroupe les outils destinés à modifier les méthodes d’affichage et de manipulation dans le Canevas. La deuxième catégorie est appelée 
Créer et contient les outils qui permettent d’ajouter de nouveaux éléments au projet, tels 
que du texte et des formes. La catégorie Masque contient les outils permettant d’ajouter 
un masque à une couche ou à un groupe existant.
Tout en haut à droite de la barre d’outils, une série d’icônes permet d’ajuster l’interface 
de Motion. Ces commandes servent à masquer et à afficher les sous-fenêtres, onglets 
et fenêtres qui constituent l’interface de Motion.
Flèche indiquant l’existence d’états 
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Le tableau suivant décrit, en les divisant en groupes, chacun des outils figurant dans 
l’ensemble par défaut. Le premier groupe est constitué par l’ensemble Présentation. 
Dès lors que vous avez sélectionné un outil et un objet dans le Canevas, appuyez 
sur la touche de tabulation pour passer à l’outil suivant. Appuyez simultanément 
sur les touches Maj + Tabulation pour parcourir les outils dans l’ordre inverse.
Outils de présentation
Les outils de présentation permettent de disposer et de manipuler des objets dans 
le Canevas. Le premier bouton de ce groupe donne accès à huit sous-outils. Pour consulter 
une liste de tous ces sous-outils, cliquez sur ce bouton et maintenez le bouton de 
la souris enfoncé.
Bouton Nom de l’outil Raccourci clavier Description
Sélectionner/
Transformer 
(flèche)
S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil à l’autre. 
Vous devez avoir 
sélectionné 
un objet pour 
pouvoir faire 
défiler les outils.)
Outil par défaut. Il sert à sélectionner et à déplacer 
des objets dans le Canevas. Vous pouvez alors 
les redimensionner en faisant glisser leurs angles ou 
les faire pivoter en faisant glisser leur point central.
Remarque : si vous avez sélectionné un autre 
outil, comme un outil Masque, appuyez sur 
la touche de tabulation pour réactiver la dernière 
option sélectionnée parmi les outils Sélectionner/
Transformer. Si vous êtes en train d’utiliser l’outil 
Ajuster transformation 3D, appuyez sur les touches 
Maj + S pour choisir l’outil Sélectionner/
Transformer.
Ajuster le point 
d’ancrage
S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil 
à l’autre.)
Change le point autour duquel un objet pivote 
ou est redimensionné. Pour l’utiliser, faites glisser 
le point d’ancrage actuel vers une nouvelle position. 
Ajuster la déformation
S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil 
à l’autre.)
Déforme un objet en déplaçant simultanément 
deux angles adjacents de cet objet et en maintenant les deux autres angles en place. 
Ajuster l’ombre 
portée
S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil 
à l’autre.)
Change la direction et le décalage de l’ombre 
portée d’un objet. Cet outil ne déplace jamais 
l’objet proprement dit.
Ajuster les quatre 
angles
S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil 
à l’autre.)
Déforme un objet en déplaçant l’un de ses angles 
et en maintenant les trois autres en place. L’image 
est étirée et déformée pour s’adapter à la forme 
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Ajuster le rognage S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil 
à l’autre.)
Vous permet de masquer des parties d’un objet 
(hormis les formes) en faisant glisser l’un des 
bords ou de ses angles.
Ajuster les points 
de contrôle
S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil 
à l’autre.)
Modifie les points et les poignées de Bézier 
pour les masques, les formes et les trajectoires 
d’animation. 
Ajuster l’élément S (Appuyez sur 
la touche de tabulation pour passer 
d’un outil 
à l’autre.)
Outil contextuel qui vous permet de modifier 
certaines commandes spéciales, telles que 
le point central d’un flou circulaire, la forme 
d’un émetteur de particules ou d’un réplicateur, 
ou les points de début et de fin d’un dégradé.
Ajuster 
transformation 3D
Q Vous permet de manipuler des objets dans 
un espace tridimensionnel grâce à des commandes de transformation et de rotation en 3D. 
Pour revenir aux commandes 2D, cliquez sur 
l’outil Sélectionner/Transformer.
Pour afficher des commandes de rotation dans 
le Canevas, appuyez sur la touche Commande.
Balance H Fait glisser votre vue du Canevas dans différentes 
directions. L’outil Balance ne déplace jamais 
d’objets individuels.
Pour réinitialiser la balance, double-cliquez sur 
l’outil Balance.
Pour effectuer la balance du Canevas sans 
sélectionner l’outil Balance, appuyez sur la barre 
espace et faites glisser la souris dans le Canevas.
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Outils de création
Ces outils servent à créer de nouvelles couches. Vous pouvez ensuite modifier 
les attributs de ces nouvelles couches dans l’Inspecteur. 
Zoom Z Effectue un zoom avant ou arrière sur le Canevas. 
Cliquez sur le point du Canevas sur lequel vous 
souhaitez effectuer le zoom, puis faites glisser 
le pointeur vers la gauche pour un zoom avant 
ou vers la droite pour un zoom arrière.
Pour réinitialiser le zoom, double-cliquez sur 
l’outil Zoom.
Pour effectuer un zoom sur une zone spécifique 
du Canevas, appuyez sur les touches Commande 
+ barre d’espace (dans cet ordre), puis définissez 
cette zone du Canevas à l’aide du pointeur. Tout 
en continuant d’appuyer sur les touches, cliquez 
afin d’effectuer un zoom avant sur le Canevas 
par incréments de 50 %. Appuyez sur les touches 
Barre d’espace + Commande + Option (dans cet 
ordre), puis cliquez dans le Canevas pour effectuer 
un zoom arrière par incréments de 50 pour cent.
Orientation 
caméra
Aucun Vous permet de naviguer dans votre scène 
comme si vous marchiez avec la caméra. Cliquez 
sur cette icône, puis appuyez sur la touche Flèche 
vers le haut, le bas, Flèche droite ou gauche pour 
naviguer.
Bouton Nom de l’outil Raccourci clavier Description
Bouton Nom de l’outil Raccourci clavier Description
Rectangle R Crée un nouvelle forme rectangulaire dans 
le Canevas, puis ajoute la couche correspondante 
à la liste de couches. Cliquez sur l’emplacement où 
vous souhaitez placer l’un des angles du rectangle, 
puis faites glisser le pointeur jusqu’à l’emplacement 
correspondant à l’angle opposé. Appuyez sur Maj 
tout en faisant glisser le pointeur pour tracer 
une couche carrée.
Cercle C Crée un nouvelle forme circulaire dans le Canevas, 
puis ajoute la couche correspondante à la liste 
de couches. Cliquez sur l’emplacement où vous souhaitez placer un point de la circonférence du cercle, 
puis faites glisser le pointeur jusqu’au point opposé. 
Appuyez sur Maj tout en faisant glisser l’objet pour 
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Ligne Aucun Crée un nouvelle forme de ligne dans le Canevas, 
puis ajoute la couche correspondante à la liste 
de couches. Cliquez à l’endroit où vous souhaitez 
commencer la ligne, puis faites glisser le pointeur 
jusqu’à son extrémité opposée. Appuyez sur Maj 
tout en faisant glisser le pointeur pour tracer 
une ligne avec des angles particuliers.
Bézier B
Alterne entre 
les outils Bézier 
et B-Spline
Crée une forme libre à l’aide de points de Bézier. 
Pour créer une forme, cliquez de manière répétée 
dans le Canevas pour ajouter des points à votre 
forme. Pour fermer la forme, cliquez à nouveau 
sur le premier point de la forme ou appuyez sur 
la touche C. Pour créer une forme ouverte, doublecliquez sur le dernier point.
B-Spline B
Alterne entre 
les outils Bézier 
et B-Spline
Crée une forme libre à l’aide de sommets B-Spline. 
Pour créer une forme, cliquez de manière répétée 
dans le Canevas pour ajouter des points à votre 
forme. Pour fermer la forme, cliquez sur le premier 
point de la forme et appuyez sur C. Pour créer une 
forme ouverte, double-cliquez sur le dernier point.
Trait de 
peinture
P Crée une forme basée sur des traits de peinture. 
Cliquez à l’endroit où vous souhaitez commencer 
le trait, puis faites glisser le pointeur pour créer 
le trait. Appuyez sur Commande tout en faisant 
glisser le pointeur pour ajuster la taille du trait 
avant de le tracer. 
Texte T Crée un nouveau texte ou vous permet de modifier 
le texte déjà présent dans une couche de texte. Pour 
créer une couche de texte, cliquez sur cet outil dans 
le Canevas, à l’endroit correspondant à la position 
du début du texte, puis commencez à saisir. Cliquez 
sur l’outil Sélectionner/Transformer (ou appuyez sur 
Échap) pour sélectionner ou déplacer la nouvelle 
couche de texte. Pour modifier le texte d’une couche de texte existante, cliquez sur l’outil Texte, puis 
sur le texte. Le texte peut alors être modifié.
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Outils Masque
Les outils Masque ne sont accessibles que si une couche (un objet visible dans 
le Canevas, tel qu’une image ou un réplicateur) ou un groupe 2D est déjà sélectionné. 
L’utilisation d’un outil Masque crée un nouveau masque qui cache certaines parties 
de la couche sélectionnée. Par défaut, la zone située à l’intérieur du masque reste visible. 
Les masques possèdent leurs propres commandes disponibles via l’Inspecteur.
Icône Nom de l’outil Raccourci clavier Description
Masque 
rectangulaire
Option + R Crée un nouveau masque rectangulaire dans le Canevas. Cliquez sur l’emplacement où vous souhaitez 
placer l’un des angles du rectangle, puis faites glisser 
le pointeur jusqu’à l’emplacement correspondant 
à l’angle opposé. Appuyez sur Maj tout en faisant 
glisser le pointeur pour tracer un masque carré.
Masque 
circulaire
Option + C Crée un nouveau masque circulaire dans le Canevas. 
Cliquez sur l’emplacement où vous souhaitez placer 
un bord du masque, puis faites glisser le pointeur 
jusqu’au point opposé. Appuyez sur Maj tout 
en faisant glisser l’objet pour tracer un masque 
en forme de cercle.
Masque à main 
levée
Aucun Crée un nouveau masque de la forme que vous tracez 
dans le Canevas. Faites simplement glisser le pointeur 
pour tracer une forme. La forme s’assure de fermer 
automatiquement le masque en reliant son premier 
et son dernier points.
Masque 
de Bézier
Option + B
Alterne entre 
les outils Masque 
de Bézier 
et B-Spline
Crée un nouveau masque de forme libre à l’aide 
de points de Bézier. Pour créer une forme, cliquez 
de manière répétée dans le Canevas pour ajouter 
des points à votre masque. Pour fermer le masque, 
cliquez sur le premier point de la forme et appuyez 
sur C. Pour créer un masque ouvert, double-cliquez 
sur le dernier point.
Masque 
B-Spline
Option + B
Alterne entre 
les outils Masque 
de Bézier 
et B-Spline
Crée un nouveau masque libre à l’aide de sommets 
B-Spline. Pour créer une forme, cliquez de manière 
répétée dans le Canevas pour ajouter des points 
à votre masque. Pour fermer le masque, cliquez sur 
le premier point de la forme et appuyez sur C. 
Pour créer une forme ouverte, double-cliquez 
sur le dernier point.38 Chapitre 1 Premiers contacts avec Motion
Icônes pour les caméras et les effets
La première icône située à droite de la barre d’outils vous permet d’ajouter une nouvelle caméra à votre projet. Les quatre icônes suivantes sont réservées aux commandes 
Effets. Ces commandes spéciales fournissent un accès instantané aux effets les plus courants. Comme ces commandes appliquent des effets à des objets existants, elles ne sont 
disponibles que si vous avez déjà sélectionné un objet.
Icône Nom de l’icône Description
Nouvelle caméra Ajoute une nouvelle caméra à l’espace de travail. Si vous ajoutez 
une caméra à un projet 2D, une zone de dialogue vous demande si vous 
souhaitez convertir vos groupes 2D en 3D. Bien qu’il soit possible d’ajouter 
une caméra à un projet 2D, elle n’a aucun effet sur les groupes 2D. 
Ajouter 
comportement
Active un menu local de comportements. Le choix d’un élément dans 
le menu applique ce comportement à l’objet sélectionné. Vous avez 
la possibilité d’appliquer des comportements à divers types d’objets, 
notamment des couches (images, émetteurs de particules, etc.), des groupes, 
des caméras et des lumières. En règle générale, la palette n’affiche qu’un 
sous-ensemble des commandes disponibles pour un comportement. 
Pour accéder à toutes ses commandes, affichez l’Inspecteur. Si l’outil 
Ajuster l’élément est sélectionné, les commandes à l’écran du comportement sont disponibles (le cas échéant).
Ajouter filtre Active un menu local de filtres. Le choix d’un élément dans le menu 
applique ce filtre à l’objet sélectionné. Vous ne pouvez appliquer des 
filtres qu’aux couches (images, texte, formes, émetteurs de particules, 
masques, réplicateurs, générateurs, etc.). Il est toutefois impossible de 
les appliquer à des caméras ou à des lumières. La palette n’affiche qu’un 
sous-ensemble des commandes disponibles pour un filtre. Pour accéder 
à toutes ses commandes, affichez l’Inspecteur. Si l’outil Ajuster l’élément 
est sélectionné, les commandes à l’écran du filtre sont disponibles 
(le cas échéant).
Générer 
particules
Utilise la couche sélectionnée (forme, texte, image, etc.) comme source 
de la cellule de particule. La couche sélectionnée à l’origine est alors 
désactivée. La palette n’affiche qu’un sous-ensemble des commandes 
disponibles pour un système de particules. Pour accéder à toutes ses 
commandes, affichez l’Inspecteur. Si l’outil Ajuster l’élément est sélectionné, les commandes à l’écran de l’émetteur de particules sont 
disponibles (sauf si vous avez choisi Point dans le menu local Forme 
de l’émetteur).
Répliquer Utilise la couche sélectionnée (forme, texte, image, etc.) comme cellule 
source du réplicateur. La couche sélectionnée à l’origine est alors désactivée. La palette n’affiche qu’un sous-ensemble des commandes disponibles pour un réplicateur. Pour accéder à toutes ses commandes, affichez 
l’Inspecteur. Si l’outil Ajuster l’élément est sélectionné, les commandes 
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Icônes d’interface
Les icônes d’interface qui se trouvent à l’extrême droite de la barre d’outils donnent 
accès aux principaux éléments de l’interface de Motion. En cliquant sur ces icônes, 
vous pouvez afficher ou masquer la fenêtre ou l’onglet correspondant. 
Personnalisation de la barre d’outils
Plusieurs options vous sont proposées pour personnaliser la barre d’outils. Vous pouvez 
définir les commandes qui apparaissent dans la barre d’outils ainsi que l’ordre dans 
lequel elles apparaissent. Vous pouvez même insérer des espaces et des séparateurs 
entre les outils, afin de les regrouper selon vos besoins. Il est également possible 
de visualiser toutes les commandes sous la forme d’icônes, d’icônes accompagnées 
de descriptions ou de simples descriptions.
Pour ajouter des commandes à la barre d’outils :
1 Pour afficher la zone de dialogue Personnaliser la barre d’outils, procédez de l’une 
des manières suivantes :
Â Choisissez Affichage > Personnaliser la barre d’outils.
Â Cliquez sur la barre d’outils en maintenant la touche Contrôle enfoncée, puis 
choisissez Personnaliser la barre d’outils dans le menu contextuel.
2 Faites glisser les boutons ou les icônes à ajouter dans l’emplacement de votre choix 
dans la barre d’outils.
3 Cliquez sur le bouton Terminé pour fermer la zone de dialogue.
Icône Nom de l’icône Raccourci clavier Description
Palette F7, D F7 active/désactive l’affichage de la palette.
Si la palette n’apparaît pas, appuyez sur D. Une fois 
qu’elle est affichée, appuyez à nouveau sur D pour 
afficher les diverses palettes disponibles pour l’objet 
sélectionné.
Navigateur Commande + 1 Affiche/masque le Navigateur. Masque et affiche 
la fenêtre Utilitaire, si le Navigateur est le seul onglet 
ouvert.
Bibliothèque Commande + 2 Affiche/masque la Bibliothèque. Masque et affiche 
la fenêtre Utilitaire, si la Bibliothèque est le seul 
onglet ouvert.
Inspecteur Commande + 3 Affiche/masque l’Inspecteur. Masque et affiche 
la fenêtre Utilitaire, si l’Inspecteur est le seul onglet 
ouvert.
Sous-fenêtre 
Projet
F5 Affiche/masque la sous-fenêtre Projet.
Fenêtre Contrôle du temps
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Pour supprimer un élément de la barre d’outils :
m Cliquez sur le bouton ou l’icône à supprimer en maintenant la touche Contrôle 
enfoncée, puis choisissez Supprimer l’élément dans le menu contextuel.
Remarque : vous pouvez également supprimer des éléments de la barre d’outils 
lorsque la fenêtre Personnaliser la barre d’outils est ouverte. Pour ce faire, faites glisser 
les éléments hors de la barre d’outils, puis relâchez le bouton de la souris. Un « petit 
nuage » apparaît puis disparaît pour indiquer que le bouton a été supprimé.
Espaces et séparateurs
Outre l’ajout et la disposition des commandes dans la barre d’outils, vous pouvez 
également ajouter des espaces, des espaces flexibles et des séparateurs afin d’arranger 
et de regrouper le contenu de votre barre d’outils.
Séparateur : ligne verticale pointillée placée entre deux commandes. Le séparateur 
ne possède qu’un rôle purement organisationnel. Dans la présentation par défaut, 
un séparateur est placé entre les icônes des effets et d’interface.
Espace : cette fonction permet d’insérer un espace d’une largeur équivalente à celle 
d’une icône entre les commandes.
Espace flexible : un espace flexible permet de répartir uniformément les commandes 
dans la barre d’outils, en utilisant autant ou aussi peu d’espace que nécessaire pour 
remplir les parties inoccupées de la barre. Dans la présentation par défaut, un espace 
flexible est utilisé entre les outils Masque et les icônes des effets.
Boutons et icônes supplémentaires
La zone de dialogue Personnaliser la barre d’outils donne accès à des icônes supplé-
mentaires qui ne font pas partie de l’ensemble par défaut.
Bouton Nom de l’outil Description
Personnaliser Ouvre la zone de dialogue Personnaliser la barre d’outils.
Couleurs Ouvre la fenêtre Couleurs.Chapitre 1 Premiers contacts avec Motion 41
Pour en savoir plus sur l’utilisation du Navigateur de modèles, voir « Création de nouveaux 
projets à partir de modèles » à la page 199.
Polices Ouvre le panneau Polices de Mac OS X. Vous pouvez 
également parcourir les polices contenues dans 
la Bibliothèque de Motion. Pour en savoir plus, voir 
l’annexe , « Utilisation de la zone de Preview des polices 
dans la Bibliothèque », à la page 627.
Nouvelle table 
lumineuse
Ajoute une nouvelle table lumineuse au projet, visible 
dans l’espace de travail 3D.
Couches Affiche ou masque l’onglet Couches dans la sous-fenêtre 
Projet.
Média Affiche ou masque l’onglet Média dans la sous-fenêtre 
Projet.
Audio Affiche ou masque l’onglet Audio dans la sous-fenêtre 
Projet.
Timeline Affiche ou masque la Timeline dans la fenêtre Contrôle 
du temps.
Éditeur d’images 
clés
Affiche ou masque l’Éditeur d’images clés dans la fenêtre 
Contrôle du temps.
Éditeur audio Affiche ou masque l’Éditeur audio dans la fenêtre Contrôle du temps.
Navigateur 
de modèles
Ouvre le navigateur de modèles.
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Moniteur vidéo : lorsqu’un moniteur supplémentaire est connecté à votre système, 
cliquez sur cette icône afin d’envoyer la sortie vers le moniteur externe. Cliquez de 
nouveau dessus afin de désactiver la sortie vers le moniteur externe. Si vous n’utilisez 
pas cette icône, vous devez choisir Motion > Préférences (ou appuyer sur les touches 
Commande + virgule), puis modifiez les réglages Sortie. Ce bouton comporte deux 
états, selon que l’option Moniteur vidéo est activée ou non.
Modification de la présentation par icônes
Les commandes de la barre d’outils peuvent être affichées sous forme d’icônes, 
de texte ou d’un mélange des deux. Par défaut, elles sont représentées par une icône 
et un nom. Une fois que vous vous êtes familiarisé avec les icônes, vous pouvez masquer 
les noms pour économiser de l’espace sur votre bureau. Pour économiser davantage 
d’espace, vous pouvez choisir de n’afficher que les noms.
Pour modifier la présentation de la barre d’outils, procédez de l’une des manières 
suivantes :
m Cliquez sur la barre d’outils en maintenant la touche Contrôle enfoncée, puis choisissez 
une option dans le menu contextuel.
m Choisissez une option dans le menu local Afficher qui se trouve dans l’angle inférieur 
gauche de la zone de dialogue Personnaliser la barre d’outils.
Icône et texte
Icône seulement
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Masquage de la barre d’outils
Une fois que vous vous êtes familiarisé avec les commandes et les raccourcis clavier 
les plus courants, vous pouvez masquer complètement la barre d’outils, afin de simplifier l’interface et d’attribuer plus d’espace au Canevas.
Pour masquer la barre d’outils, procédez de l’une des manières suivantes :
m Cliquez sur le bouton de la barre d’outils situé dans l’angle supérieur droit de 
la fenêtre principale.
m Choisissez Présentation > Masquer la barre d’outils.
m Appuyez simultanément sur les touches Commande + Option + T.
Si la barre d’outils est actuellement masquée, les mêmes commandes ont pour 
fonction de l’afficher plutôt que de la masquer.
Canevas
Le Canevas constitue l’élément clé de l’espace de travail dans Motion. Tout ce que 
vous voyez dans le Canevas reflète exactement ce que vous obtenez après avoir 
exporté ou sorti votre projet. Cette fenêtre n’est toutefois pas simplement un endroit 
où vous pouvez voir le résultat de votre travail, mais également un endroit où vous 
pouvez modifier et arranger les éléments de votre projet.
Bouton de la barre 
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Vous pouvez manipuler directement les éléments dans le Canevas, afin de modifier leurs 
attributs physiques tels que la position, l’échelle et la rotation, ou utiliser les techniques 
habituelles de glisser-déposer pour leur appliquer directement des comportements ou 
des filtres. Pour en savoir plus sur ces fonctions, voir le chapitre 5, « Utilisation des 
comportements », à la page 405 et le chapitre 10, « Utilisation des filtres », à la page 909. 
Barre d’état
Une Barre d’état affichée en haut du Canevas, sous la barre d’outils, fournit 
des informations sur votre projet. Elle peut contenir trois types d’informations : 
Couleur, Coordonnées et Fréquence d’images.
Barre d’état Options de 
présentation
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Couleur
Certains projets d’animation graphique nécessitent parfois l’harmonisation des différentes 
couleurs de votre projet. La Barre d’état peut vous fournir des informations visuelles 
et numériques sur la couleur du pixel actuellement situé sous le pointeur, ainsi que 
sur la valeur du canal alpha. Il n’est pas nécessaire de cliquer : les informations de la 
Barre d’état sont actualisées au fur et à mesure que vous déplacez le pointeur.
Pour afficher la couleur du pixel actuel dans la Barre d’état:
m Cliquez sur la Barre d’état tout en maintenant la touche Contrôle enfoncée, choisissez 
Couleur dans le menu contextuel, puis positionnez le pointeur sur le Canevas.
Vous pouvez ainsi savoir quelles sont les valeurs exactes de couleur et alpha du pixel 
examiné. La couleur est indiquée numériquement dans l’un des trois formats suivants :
RVBA : composantes rouge, verte, bleue et alpha de la couleur exprimées sous forme 
de valeurs comprises entre 0 et 255.
RVBA (en pour cent) : composantes rouge, verte, bleue et alpha de la couleur exprimées 
sous forme de valeurs comprises entre 1 et 100.
TSL : la teinte est représentée par des nombres allant de 1 à 360, tandis que la saturation 
et la valeur (luminance) sont représentées par des nombres allant de 1 à 100.
Pour choisir entre l’affichage des couleurs RVB, RVB (en pour cent) et TSL :
m Cliquez sur la Barre d’état tout en maintenant la touche Contrôle enfoncée, 
choisissez un espace colorimétrique dans le menu contextuel.
Remarque : l’option Couleur doit être activée dans la Barre d’état pour pouvoir choisir 
un espace colorimétrique.
Coordonnées
Pour placer avec précision des objets dans le Canevas, il peut s’avérer utile de connaître 
à tout moment la position exacte du pointeur exprimée en pixels. La Barre d’état peut 
afficher cette information dans un système de coordonnées X et Y (cartésien). Le point 
central du Canevas occupe la position 0,0.
Pour afficher la position actuelle du pointeur dans la Barre d’état :
m Cliquez sur la Barre d’état tout en maintenant la touche Contrôle enfoncée, 
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Fréquence d’images
L’une des méthodes utilisées par Motion pour lire votre projet en temps réel consiste 
à réduire la fréquence d’images dès que la séquence est trop complexe pour effectuer 
un rendu à la vitesse normale. Vous pouvez surveiller la fréquence d’images actuelle 
dans la Barre d’état. Elle est exprimée en images par seconde (ips). 
Remarque : ce nombre n’apparaît que durant la lecture du projet.
Pour surveiller la fréquence d’images de lecture du projet :
m Cliquez sur la Barre d’état en maintenant la touche Contrôle enfoncée, puis choisissez 
Fréquence d’images dans le menu contextuel.
Vous pouvez également activer ou désactiver les éléments de la Barre d’état via 
la fenêtre de Préférences Apparence. Pour afficher les préférences de Motion, 
sélectionnez Motion > Préférences.
Options de présentation du Canevas
Le Canevas est un espace de travail polyvalent doté de nombreuses options destinées 
à optimiser le flux de travaux de différents types de projets. Il comprend par exemple 
des règles, des grilles et des guides pour vous aider à aligner et à disposer les objets.
Il comprend également un certain nombre de commandes destinées à visualiser 
un seul canal de couleur dans le Canevas. Vous pouvez utiliser ces commandes pour 
examiner les canaux alpha des couches ou pour manipuler des effets qui n’ont 
un impact que sur un seul canal de couleur.
Vous pouvez également définir des options permettant d’accélérer la lecture en réduisant la qualité d’image, afin de pouvoir visionner des projets complexes à des fréquences 
d’images élevées à mesure que vous les construisez. Cela vous permet d’obtenir rapidement une ébauche de votre composition. Il est possible de désactiver temporairement 
certains effets, tels que le flou d’animation et le rendu de trames, qui ont un impact 
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Par ailleurs, vous pouvez afficher le Canevas en mode 2D ou 3D, ce qui vous permet de 
positionner des couches et des groupes dans un espace tridimensionnel. Pour en savoir 
plus sur l’utilisation du Canevas en mode 3D, voir « Canevas en mode 3D » à la page 61.
Les cinq menus locaux situés à droite de la Barre d’état vous permettent d’accéder 
aux réglages suivants : Niveau de zoom, Résolution, Canaux, Affichage et options 
d’incrustation, ainsi que les options de présentation 3D.
Niveau de zoom
Vous pouvez effectuer un zoom avant sur le Canevas pour aligner et placer des objets 
de manière précise et un zoom arrière pour obtenir une vue d’ensemble du projet 
ou visualiser la trajectoire d’un objet mobile. Le menu local Niveau de zoom propose 
plusieurs niveaux de zoom par défaut. Vous pouvez également utiliser les modes de 
zoom dynamique pour effectuer rapidement un zoom avant ou arrière sur le Canevas, 
ou pour effectuer un zoom sur des zones spécifiques du Canevas.
Le fait d’effectuer un zoom sur le Canevas ne modifie pas réellement la taille 
des images de votre projet. Cela ne fait que modifier la présentation actuelle 
de la totalité de la fenêtre.
Pour effectuer un zoom avant ou arrière sur le Canevas :
m Choisissez un niveau de zoom dans le menu local Niveau de zoom.
Dans l’image ci-dessous, le menu local Niveau de zoom est réglé sur 50 %.
Canaux Affichage et incrustation
Niveau de zoom
Résolution
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Pour utiliser le mode de zoom dynamique :
m Appuyez sur Commande + barre espace, puis faites glisser la souris en diagonale sur 
le Canevas. Le zoom est effectué autour du point sur lequel vous avez cliqué dans 
le Canevas.
Pour effectuer un zoom avant sur une zone spécifique du Canevas :
m Appuyez sur les touches Barre d’espace + Commande (dans cet ordre), puis définissez 
à l’aide du pointeur la zone du Canevas sur laquelle vous souhaitez effectuer un zoom. 
Tout en continuant à appuyer sur ces touches, cliquez afin d’effectuer un zoom avant 
par incréments de 50 % par rapport au niveau de zoom actuel. Appuyez sur les touches 
Barre d’espace + Commande + Option (dans cet ordre), puis cliquez dans le Canevas 
pour effectuer un zoom arrière par incréments de 50 pour cent par rapport au niveau 
de zoom actuel.
Remarque : pour effectuer la balance du Canevas sans sélectionner l’outil Balance, 
appuyez sur la barre espace et faites glisser la souris dans le Canevas.
Pour réinitialiser le niveau de zoom du Canevas, procédez de l’une des manières 
suivantes :
m Choisissez 100 % dans le menu local Niveau de zoom.
m Dans la barre d’outils, double-cliquez sur l’outil Zoom (entre les outils Balance 
et Orientation caméra).
Pour réinitialiser la balance du Canevas :
m Dans la barre d’outils, double-cliquez sur l’outil Balance.
Pour zoomer sur le Canevas de façon à ce que toute la zone affichable du projet 
remplisse la fenêtre :
m Choisissez Ajuster à la fenêtre dans le menu local Niveau de zoom.
Résolution
Si vous travaillez sur un projet très complexe que votre ordinateur n’arrive à lire qu’à 
une fréquence d’images très basse, vous pouvez réduire la résolution du Canevas afin 
de diminuer la charge du processeur. Cela vous évite de devoir attendre la fin du rendu 
de l’image en résolution complète chaque fois que vous effectuez une modification. Plus 
la résolution est faible, plus la texture transmise à votre carte graphique est peu précise.
Le menu local Résolution vous propose les options suivantes :
Complète : affiche le Canevas en haute résolution
Moitié : affiche le Canevas à la moitié de la résolution
Tiers : affiche le Canevas à un tiers de la résolution
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Pour modifier la résolution du Canevas :
m Choisissez le niveau de réduction d’image souhaité via le menu local Résolution.
Remarque : il existe une autre commande Qualité de rendu dans le menu Affichage 
et incrustation qui gère en post-traitement la qualité du rendu des images, du texte 
ou des particules, plutôt que de l’ensemble du Canevas. Pour en savoir plus, 
voir « Affichage et incrustation » à la page 50.
Canaux
Le menu local Canaux permet de déterminer quels canaux de couleur sont affichés 
dans le Canevas. Ce menu propose les options suivantes :
Couleur : affiche l’image telle qu’elle apparaît sur un moniteur vidéo. Les couches visibles sont affichées en couleurs naturelles et les zones transparentes révèlent la couleur 
d’arrière-plan définie dans la zone de dialogue Propriétés du projet. Par défaut, cette 
couleur est réglée sur noir. Pour modifier la couleur d’arrière-plan du projet, choisissez 
Édition > Propriétés du projet (ou appuyez sur les touches Commande + J), puis cliquez ou cliquez tout en maintenant la touche Contrôle enfoncée sur le cadre Couleur 
d’arrière-plan.
Remarque : dans l’onglet Générales de la zone de dialogue Propriétés du projet, 
le menu local Arrière-plan doit être réglé sur Couleur unie pour que la couleur d’arrièreplan soit exportée avec le projet. Cette option crée un canal alpha opaque au moment 
de l’exportation (en cas d’utilisation d’un codec prenant en charge les canaux alpha). 
Si le menu local Arrière-plan doit est réglé sur Transparent, le couleur est visible dans 
le Canevas, mais son rendu n’est pas effectué comme faisant partie du canal alpha.
Transparent : affiche la zone d’arrière-plan du Canevas comme si elle était transparente. 
Un motif en damier est affiché par défaut lorsqu’aucune image ne bloque l’arrière-plan.
Incrustation alpha : affiche l’image en couleurs normales, mais ajoute une surbrillance 
rouge sur les zones transparentes de l’image.
RVB seulement : affiche le mélange normal des canaux rouge, vert et bleu, 
mais les zones transparentes (y compris les zones semi-transparentes) apparaissent 
comme des zones opaques.
Rouge : n’affiche que le canal rouge comme plage allant du noir au blanc.
Vert : n’affiche que le canal vert comme plage allant du noir au blanc.
Bleu : n’affiche que le canal bleu comme plage allant du noir au blanc.
Alpha : affiche le canal alpha (transparence) des couches dans le Canevas.
Alpha inversé : ce réglage affiche une vue inversée du canal alpha (transparence).50 Chapitre 1 Premiers contacts avec Motion
Affichage et incrustation
Ce menu local donne accès à divers types de guides et de commandes que vous avez 
la possibilité d’afficher dans le Canevas. Il comporte également des commandes 
permettant de désactiver les fonctions nécessitant beaucoup de rendu, par exemple 
le flou d’animation, afin d’accélérer la lecture du Canevas. Lorsqu’une option est activée, 
une coche apparaît en regard de son nom dans le menu.
Remarque : ces options sont également disponibles dans le menu déroulant Présentation.
Afficher les incrustations : active ou désactive l’affichage de toutes les incrustations 
dans le Canevas. Ce réglage doit être activé pour visualiser un élément incrusté 
quelconque (grille, guide, etc.). Pour activer/désactiver les incrustations de caméra, 
choisissez Afficher les incrustations 3D.
Remarque : vous pouvez également appuyer sur les touches Commande + /.
Règles : active ou désactive l’affichage des règles tout autour du Canevas. Vous pouvez 
spécifier l’emplacement des règles via la section Canevas des préférences de Motion. 
Pour en savoir plus sur l’utilisation des règles, voir « Utilisation des règles du Canevas » 
à la page 59.
Remarque : vous pouvez également appuyer sur les touches Commande + Maj + R.
Grille : active ou désactive l’affichage d’une grille sur le Canevas. Vous pouvez définir 
la couleur et le pas (espacement) de la grille dans la section Canevas des préférences 
de Motion.
Remarque : vous pouvez également appuyer sur les touches Commande + apostrophe (‘).
Guides : active ou désactive l’affichage des guides créés manuellement. Les guides 
ne peuvent être créés que si les règles sont également affichées. Vous pouvez modifier 
la couleur des guides via la section Canevas des préférences de Motion.
Remarque : vous pouvez également appuyer sur les touches Commande + point-virgule (;).
Guides dynamiques : active ou désactive l’affichage des guides dynamiques 
automatiques. Ces guides apparaissent lorsque vous faites glisser une couche au-delà 
des bords d’autres couches. Vous pouvez modifier la couleur des guides dynamiques 
via la section Canevas des préférences de Motion.
Remarque : vous pouvez également appuyer sur les touches Commande + 
Maj + point-virgule (;).
Zones sécurisées : active ou désactive l’affichage des guides Titre sécurisé et Zone 
d’action sécurisée. Ces guides sont réglés par défaut sur 80 et 90 %. Vous pouvez 
modifier ces réglages ainsi que la couleur des guides via la section Canevas des 
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Remarque : vous pouvez également appuyer sur la touche Apostrophe (‘).
Zone du film : active ou désactive l’affichage des guides de proportions. Cette option 
peut s’avérer utile si vous êtes en train de créer un projet sur bande vidéo destiné à être 
transféré sur film. Vous pouvez modifier la taille des guides ainsi que leur couleur via la 
section Canevas des préférences de Motion.
Remarque : vous pouvez également appuyer sur les touches Maj + apostrophe (‘).
Poignées : active ou désactive l’affichage des poignées d’objet dans le Canevas. 
Leur affichage est nécessaire pour effectuer certaines transformations à l’écran, telles que 
le redimensionnement. Les poignées n’apparaissent que sur les objets sélectionnés.
Lignes : active ou désactive l’affichage des lignes de contour d’un objet.
Trajectoire d’animation : active ou désactive les trajectoires d’animation. Ces trajectoires modifiables indiquent le parcours emprunté par les objets animés. Si l’objet sélectionné n’est pas animé en fonction de sa position, cette commande ne semble avoir 
aucun effet. Si les poignées ne sont pas affichées, il est impossible d’ajuster les trajectoires d’animation dans le Canevas. Les trajectoires d’animation créées par des comportements, à l’exception du comportement Trajectoire d’animation, sont simplement 
affichées, mais ne peuvent pas être modifiées.
Afficher les incrustations 3D : désactive toutes les incrustations 3D, notamment 
celles des caméras, des outils Présentation 3D, Boussole, Présentation cadre, Grille 3D 
et des Icônes scène 3D.
Remarque : vous pouvez également appuyer sur les touches Commande + Option + /.
Outils Présentation 3D: active et désactive le menu Caméra ainsi que les outils 
Présentation 3D.
Boussole : active et désactive l’outil Boussole 3D. Grâce à des axes rouge, vert et bleu, 
la boussole vous affiche l’orientation actuelle dans l’espace 3D. L’axe X (horizontal) 
est rouge, l’axe Y (vertical) vert et l’axe Z (profondeur) bleu.
Menu Caméra Outils Présentation 3D
Balance Travelling
En orbite
Caméra
en cours de
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Si vous maintenez le pointeur au-dessus de la boussole 3D, il se transforme en sélecteur 
de présentation 3D. Cliquez sur l’une des icônes de couleur (Avant, Gauche, Droite, 
Perspective, etc.) pour afficher la présentation correspondante. Le Canevas s’anime 
alors en fonction de la nouvelle présentation sélectionnée. Pour en savoir plus sur 
l’utilisation de la boussole et des diverses présentations, voir « compositing 3D » dans 
le manuel Motion Supplemental Documentation PDF.
Présentation cadre : active et désactive la présentation cadre. Lorsque cette option 
est activée, une fenêtre temporaire apparaît dans le coin inférieur droit du Canevas. 
Elle affiche la vue de la caméra activée ou la vue en perspective de votre projet, ce qui 
vous aide à vous orienter au fil du déplacement d’objets dans l’espace 3D. Vous pouvez 
modifier sa taille et indiquer si vous souhaitez qu’elle apparaisse lors des transformations seulement, lors de toutes les modifications ou à la demande.
La Présentation cadre affiche la vue Perspective ou Caméra activée. La vue Perspective 
est mise à jour de façon dynamique pour s’ajuster aux objets affichés par la Présentation 
cadre (même si ces objets ne sont plus visibles dans la fenêtre principale). Elle est déclenchée si vous êtes déjà en train d’observer les objets au moyen d’une caméra. Quant à la 
vue Activée, elle est déclenchée si vous avez choisi une présentation de caméra diffé-
rente de la caméra activée (comme Face). Pour en savoir plus sur la Présentation cadre, 
voir « 3D » à la page 164.
Boussole 3D Sélecteur de 
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Remarque : les éléments d’un projet étant des objets 2D (plats), ils ne sont pas visibles 
lorsque vous utilisez les vues orthogonales d’une caméra (Gauche, Droite, Haut et Bas), 
sauf si ces éléments sont pivotés en 3D (ou que le paramètre Face à la caméra du texte, 
des particules ou du réplicateur est activé dans l’Inspecteur). En effet, les vues orthogonales sont réalisées à angle droit par rapport aux éléments (perpendiculairement). 
Lorsqu’un objet est sélectionné, il est représenté par une fine ligne grise dans le Canevas. 
Pour en savoir plus sur l’utilisation des caméras, voir « compositing 3D » dans le manuel
Motion Supplemental Documentation PDF.
Grille 3D: active ou désactive la grille sur les présentations 3D. Cette grille 3D vous 
aide à vous orienter et peut servir de guide lors du positionnement d’objets dans 
votre projet. Elle n’apparaît que si vous vous trouvez dans un espace de travail 3D.
Présentation cadre
Les particules en forme de cœur sont visibles dans la Présentation cadre 
(qui constitue une vue en perspective du projet), car le paramètre Face 
à la caméra est activé dans l’Inspecteur Émetteur de particules.54 Chapitre 1 Premiers contacts avec Motion
Icônes scène 3D : affiche ou masque les caméras et les lumières. Ces icônes apparaissent 
sur le Canevas comme des éléments jaunes en fil de fer. Les lumières sont affichées avec 
des poignées d’ajustement 3D rouge (X), verte (Y) et bleue (Z) qui vous permettent 
de les transformer et les faire pivoter. Ces poignées restent affichées même si l’option 
Icônes scène 3D est désactivée. Pour en savoir plus sur les icônes scène 3D, voir 
« compositing 3D » dans le manuel Motion Supplemental Documentation PDF.
Respecterles proportions : applique une déformation artificielle du Canevas pour 
les projets à pixels non carrés. Lorsque cette option est activée, votre moniteur simule 
l’affichage d’un écran télévision. Lorsque l’option est désactivée, les projets à pixels 
non carrés prennent un aspect étiré. Cela tient au fait que les moniteurs informatiques 
affichent des pixels carrés. Cette option ne modifie pas le projet final proprement dit.
Afficher zone de présentation totale : vous permet de visualiser une partie d’une 
couche située au-delà des limites du Canevas. Ce réglage est désactivé par défaut, 
car il ralentit l’interactivité de votre projet.
Lumière
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Qualité de rendu : définit le mode d’affichage des objets, tels que le texte et les images, 
dans le Canevas. Vous avez le choix entre : Brouillon, Normale ou Optimale.
Â Brouillon : exécute un rendu de faible qualité des objets dans le Canevas, afin d’assurer 
une interactivité optimale à votre projet.
Â Normale : réglage par défaut. Exécute un rendu de qualité moyenne des objets 
dans le Canevas.
Â Optimale : exécute un rendu d’excellente qualité des objets dans le Canevas. 
Cette option ralentit l’interactivité de votre projet.
Remarque : dans le Canevas, les fichiers YUV à 10 bits sont rendus à 8 bits, à moins 
que la Qualité de rendu ne soit réglée sur Optimale.
∏ Astuce : si vous cochez la case « Séquence - Utiliser les réglages du projet et du Canevas 
actuels » lors de l’exportation d’un projet (dans le menu local Utiliser de la zone de 
dialogue d’exportation), réglez Qualité de rendu sur Optimale avant de procéder à 
l’exportation.
Éclairage : active ou désactive l’effet des lumières dans votre projet. Bien que cette 
option ne désactive pas les lumières dans la liste des couches, ni les icônes scène 3D 
des lumières, elle désactive les effets de lumière dans le Canevas.
Lorsque ce réglage est activé et que vous utilisez un préréglage d’exportation par 
défaut (tel que film DV NTSC), votre projet est exporté avec les lumières. En effet, les 
préréglages d’exportation sont exportés par défaut avec l’option « Utiliser les réglages 
du projet et du Canevas actuels » activée (dans l’onglet Sortie de la zone de dialogue 
Options d’exportation). Si cette case est cochée, tout ce qui est activé dans le menu 
Présentation est également exporté. 
Pour remplacer les réglages actuels du projet relatifs à l’éclairage lors de l’exportation :
1 Choisissez Fichier > Exporter.
2 Facultatif : sélectionnez un nom et un emplacement pour le fichier enregistré.
3 Dans la zone de dialogue d’exportation, cliquez sur le bouton Options en regard 
du menu local Exporter.
4 Sous l’onglet Sortie de la zone de dialogue Options d’exportation, désactivez l’option 
« Utiliser les réglages actuels du projet et du Canevas ».
Les options affichées par l’onglet Sortie sont alors accessibles, notamment les réglages 
Résolution, Couleur, Fréquence d’images, Caméra, Éclairage, Qualité de rendu, Rendu 
de trames, Flou d’animation et Fusion d’images.
Lorsque la case Éclairage est cochée, le projet est exporté avec les lumières, quel que soit 
l’état Éclairage dans le menu Présentation.56 Chapitre 1 Premiers contacts avec Motion
Rendu de trames : la désactivation de cette option désactive le rendu de trames 
requis pour une lecture fluide sur un écran de télévision. Comme le rendu de trame 
double la durée du rendu, la désactivation de cette option peut améliorer considérablement les performances.
Si ce réglage est activé dans le menu Présentation et que vous utilisez un préréglage 
d’exportation par défaut (« Séquence - Utiliser les réglages du projet et du Canevas 
actuels »), votre projet est exporté avec le rendu de trames. (Le codec utilisé par défaut 
est alors Animation, 8 bits, Couleur + Alpha.) Si vous conservez ce réglage par défaut, 
toutes les options choisies dans le menu local Présentation (ou le menu déroulant 
Présentation), ainsi que tous les réglages effectués dans la zone de dialogue Propriétés 
du projet sont également exportés.
Toutefois, si vous choisissez un autre préréglage, le rendu de trames est activé sur la base 
du préréglage sélectionné (si ce codec particulier exige ou non des trames). Par exemple, 
si vous choisissez Film NTSC DV, le rendu trames est activé, car des trames sont attendues 
pour ce format. En revanche, si vous choisissez Film DVCPRO HD 720p24, le rendu de trames est désactivé, car il s’agit d’un format de film à balayage progressif (sans trame).
Remarque : lorsque vous ouvrez un projet Motion dans une autre application, telle que 
Final Cut Pro ou DVD Studio Pro, le réglage Rendu de trames du menu local Présentation 
ne contrôle pas si le rendu de trames est activé ou non. Ce paramètre est contrôlé dans la 
zone de dialogue Propriétés du projet (accessible en appuyant sur les touches Commande 
+ J). Si l’option Ordre de trame est définie sur toute autre valeur que Aucun, le rendu de 
trames est utilisé dans l’autre application, quel que soit l’état Rendu de trames dans le 
menu Présentation.
Pour remplacer les réglages actuels du projet relatifs au rendu de trames lors 
de l’exportation :
1 Choisissez Fichier > Exporter.
2 Facultatif : sélectionnez un nom et un emplacement pour le fichier enregistré.
3 Dans la zone de dialogue d’exportation, cliquez sur le bouton Options en regard 
du menu local Exporter.
4 Sous l’onglet Sortie de la zone de dialogue Options d’exportation, désactivez l’option 
« Utiliser les réglages actuels du projet et du Canevas ».
Remarque : si vous avez déjà choisi un autre préréglage d’exportation dans le menu 
local Utiliser de la zone de dialogue d’exportation, l’option « Utiliser les réglages du 
projet et du Canevas actuels » est désactivée.
Les options affichées par l’onglet Sortie sont alors accessibles, notamment les réglages 
Résolution, Couleur, Fréquence d’images, Caméra, Éclairage, Qualité de rendu, Rendu 
de trames, Flou d’animation et Fusion d’images.Chapitre 1 Premiers contacts avec Motion 57
Lorsque la case Rendu de trames est cochée dans l’onglet Sortie, le projet est exporté 
avec le rendu de trames, quel que soit l’état Rendu de trames dans le menu Présentation.
Flou d’animation : la désactivation de ce réglage désactive la prévisualisation du flou 
d’animation dans le Canevas, ce qui peut entraîner une amélioration considérable des 
performances. Lors de l’utilisation d’un préréglage d’exportation par défaut, ce réglage 
n’a aucun effet sur la sortie actuelle de votre projet. Aucun des préréglages d’exportation 
par défaut n’est réglé pour utiliser le flou d’animation.
Si ce réglage est activé dans le menu Présentation et que vous utilisez un préréglage 
d’exportation par défaut (« Séquence - Utiliser les réglages du projet et du Canevas 
actuels »), votre projet est exporté avec le flou d’animation. (Le codec utilisé par défaut 
est alors Animation, 8 bits, Couleur + Alpha.) Si vous conservez ce réglage par défaut, 
toutes les options choisies dans le menu local Présentation (ou le menu déroulant 
Présentation), ainsi que tous les réglages effectués dans la zone de dialogue Propriétés 
du projet sont également exportés.
Toutefois, si vous choisissez un autre préréglage, le flou d’animation est désactivé par 
défaut et doit être activé manuellement dans le préréglage sélectionné. Par exemple, 
si vous choisissez Film NTSC DV, le flou d’animation est désactivé. Vous pouvez toujours 
modifier les paramètres d’un préréglage, comme indiqué ci-après.
Remarque : lorsque vous ouvrez un projet Motion dans une autre application, telle que 
Final Cut Pro, le réglage Flou d’animation dans le menu local Présentation contrôle si 
le flou d’animation est appliqué ou non.
Pour remplacer les réglages actuels du projet relatifs au flou d’animation lors 
de l’exportation :
1 Choisissez Fichier > Exporter.
2 Facultatif : sélectionnez un nom et un emplacement pour le fichier enregistré.
3 Dans la zone de dialogue d’exportation, cliquez sur le bouton Options en regard 
du menu local Exporter.
4 Sous l’onglet Sortie de la zone de dialogue Options d’exportation, désactivez l’option 
« Utiliser les réglages actuels du projet et du Canevas ».
Remarque : si vous avez déjà choisi un autre préréglage d’exportation dans le menu 
local Utiliser de la zone de dialogue d’exportation, l’option « Utiliser les réglages 
du projet et du Canevas actuels » est désactivée.
Les options affichées par l’onglet Sortie sont alors accessibles, notamment les réglages 
Résolution, Couleur, Fréquence d’images, Caméra, Éclairage, Qualité de rendu, Rendu de 
trames, Flou d’animation et Fusion d’images.
Lorsque la case Flou d’animation est cochée, le projet est exporté avec le flou 
d’animation, quel que soit l’état Flou d’animation dans le menu Présentation.58 Chapitre 1 Premiers contacts avec Motion
Fusion d’images : la désactivation de ce réglage désactive la fusion d’images dans le 
Canevas. La fusion d’images permet de lisser l’apparence des images vidéo en interpolant 
les pixels situés entre deux images adjacentes, afin de créer une transition plus lisse.
Si ce réglage est activé dans le menu Présentation et que vous utilisez un préréglage 
d’exportation par défaut (« Séquence - Utiliser les réglages du projet et du Canevas 
actuels »), votre projet est exporté avec la fusion d’images. (Le codec utilisé par défaut 
est alors Animation, 8 bits, Couleur + Alpha.) Si vous conservez ce réglage par défaut, 
toutes les options choisies dans le menu local Présentation (ou le menu déroulant 
Présentation), ainsi que tous les réglages effectués dans la zone de dialogue Propriétés 
du projet sont également exportés.
Toutefois, si vous choisissez un autre préréglage, la fusion d’images est activée sur la base 
du préréglage sélectionné. Par exemple, si vous choisissez Film NTSC DV, la fusion d’images est activée. Vous pouvez toujours modifier les paramètres d’un préréglage, comme 
indiqué ci-après.
Pour remplacer les réglages actuels du projet relatifs à la fusion d’images lors 
de l’exportation :
1 Choisissez Fichier > Exporter.
2 Facultatif : sélectionnez un nom et un emplacement pour le fichier enregistré.
3 Dans la zone de dialogue d’exportation, cliquez sur le bouton Options en regard 
du menu local Exporter.
4 Sous l’onglet Sortie de la zone de dialogue Options d’exportation, désactivez l’option 
« Utiliser les réglages actuels du projet et du Canevas ».
Remarque : si vous avez déjà choisi un autre préréglage d’exportation dans le menu 
local Utiliser de la zone de dialogue d’exportation, l’option « Utiliser les réglages 
du projet et du Canevas actuels » est désactivée.
Les options affichées par l’onglet Sortie sont alors accessibles, notamment les réglages 
Résolution, Couleur, Fréquence d’images, Caméra, Éclairage, Qualité de rendu, Rendu 
de trames, Flou d’animation et Fusion d’images.
Lorsque l’option Fusion d’images est activée, le projet est exporté avec la fusion 
d’images, quel que soit l’état Fusion d’images dans le menu Présentation.
Preview de la profondeur de bits en virgule flottante : lors de l’utilisation de l’espace 
en virgule flottante, la désactivation de cette option passe à 8 bits le Preview dans 
le Canevas. Étant donné que l’utilisation de l’espace en virgule flottante augmente 
de façon considérable le temps de traitement, la désactivation de ce paramètre permet 
d’accélérer les opérations. Cette option ne modifie pas le projet final proprement dit.
Remarque : pour en savoir plus sur l’espace en virgule flottante, voir « À propos de la 
profondeur de bits » à la page 203.Chapitre 1 Premiers contacts avec Motion 59
Utilisation des règles du Canevas
L’utilisation des règles du Canevas peut vous aider à composer ou à aligner les éléments 
de votre projet, ainsi qu’à aligner les objets sur les règles.
Pour activer les règles :
m Dans le menu local Présentation, activez l’option Règles (ou appuyez sur les touches 
Commande + Maj + R). Lorsque cette option est activée, une coche apparaît en regard 
de l’élément dans le menu local.
Par défaut, les règles apparaissent le long des côtés gauche et supérieur du Canevas. 
Vous pouvez modifier l’emplacement des règles dans la section Canevas 
des préférences Motion.
Pour ajouter un guide horizontal ou vertical au Canevas :
1 Dans la barre d’outils, cliquez sur l’outil Sélectionner/Transformer (ou appuyez sur 
la touche S).
2 Cliquez dans la zone grise de la règle horizontale ou verticale et faites glisser la souris 
dans le Canevas.
Tandis que vous faites glisser la souris, la valeur du guide s’affiche dans le Canevas.
Remarque : l’option Guides doit être activée dans le menu Présentation (en appuyant 
sur les touches Commande + point-virgule).
Les unités de la règle sont en pixels, avec le point 0,0 au centre du Canevas.
3 Lorsque le guide apparaît à l’endroit souhaité, relâchez le bouton de la souris.60 Chapitre 1 Premiers contacts avec Motion
Pour ajouter simultanément une règle horizontale et verticale au Canevas :
1 Dans la barre d’outils, cliquez sur l’outil Sélectionner/Transformer (ou appuyez sur 
la touche S).
2 Faites glisser à partir de l’angle dans lequel les règles se rejoignent dans le Canevas.
3 Lorsque les guides apparaissent à l’endroit souhaité, relâchez le bouton de la souris.
Pour supprimer un guide du Canevas :
m Dans la barre d’outils, cliquez sur l’outil Sélectionner/Transformer (ou appuyez sur S), 
puis faites glisser le guide à l’extérieur du Canevas.
Pour changer l’emplacement des règles :
1 Choisissez Motion > Préférences. 
2 Dans la section Canevas, choisissez une présentation de règle dans le menu local 
Emplacement de la règle.
Pour changer la couleur des guides :
1 Choisissez Motion > Préférences.
2 Dans la section Canevas, cliquez ou cliquez tout en maintenant la touche Contrôle 
enfoncée sur le cadre Couleur des guides, puis sélectionnez une couleur.
Présentation 3D
Ce menu local vous permet d’indiquer la façon dont vous souhaitez visualiser votre 
projet dans le Canevas. En effet, vous avez le choix d’afficher le Canevas comme un 
espace de travail unique ou opter pour l’une des dispositions de fenêtres disponibles 
dans ce menu. Les exemples suivants illustrent deux des présentations proposées.
Remarque : bien que les diverses présentations de l’espace de travail soient disponibles 
pour les projets 2D, elles revêtent tout leur intérêt lorsque vous travaillez en 3D.
Disposition avec deux fenêtres en haut et une en bas Disposition avec quatre fenêtresChapitre 1 Premiers contacts avec Motion 61
Canevas en mode 3D
Hormis l’espace de travail habituel pour les projets 2D, Motion offre un espace de travail 3D 
dans lequel vous pouvez organiser et animer divers objets, comme des groupes, des couches, des caméras et des lumières. Dès que vous basculez en mode 3D, le Canevas affiche 
des commandes complémentaires adaptées à ce nouvel environnement. Un jeu d’outils 
de présentation 3D restreint apparaît dans le coin supérieur droit du Canevas, alors qu’une 
boussole 3D est affichée dans le coin inférieur gauche. Un menu Caméra apparaît également dans le coin supérieur gauche du Canevas pour vous permettre de choisir quelle 
caméra utiliser pour visualiser votre projet en espace 3D.
Remarque : vous devez ajouter au moins une caméra à votre projet pour créer 
un espace de travail 3D.
Pour ajouter une caméra à votre projet:
1 Cliquez sur l’icône Nouvelle caméra dans la barre d’outils.
Une zone de dialogue vous invite à convertir vos groupes 2D en 3D.
2 Cliquez sur Basculer en 3D pour ajouter une caméra et créer un projet 3D.
Remarque : si vous cliquez sur Conserver en 2D, une caméra est ajoutée à votre projet, 
mais tous les groupes restent en 2D.
Utilisation de la présentation 3D
L’espace de travail 3D comporte des outils qui vous permettent de modifier manuellement 
la présentation ou le mode d’affichage de votre scène à partir d’une caméra particulière, 
grâce à des options telles que Avant, Arrière, Haut, Bas, etc. Vous pouvez également choisir 
de visualiser la scène au travers de toute caméra ajoutée à votre projet.
Remarque : les présentations de caméra Gauche, Droite, Bas et Haut sont des vues 
orthogonales. Vous ne pouvez ni les animer, ni les exporter.
Pour régler la présentation en cours :
m Cliquez sur le menu Caméra dans le coin supérieur gauche du Canevas, puis choisissez 
une caméra. Le Canevas s’anime alors en fonction du nouvel affichage sélectionné.
Si vous avez modifié la présentation, un astérisque apparaît en regard de son nom.62 Chapitre 1 Premiers contacts avec Motion
Remarque : si vous avez isolé une couche ou un groupe (en choisissant Objet > Isoler), 
le menu Caméra affiche le nom de l’objet isolé comme étant la présentation actuelle. 
Pour en savoir plus sur la fonction Isoler, voir « Onglet Couches » à la page 75.
Pour utiliser les outils Présentation 3D :
m Faites glisser l’outil Balance, Orbite ou Travelling parmi les outils Présentation 3D.
Comme si la caméra se déplaçait, l’affichage bouge, pivote ou est agrandi/réduit.
Important : l’icône représentant la caméra grise est un rappel : lorsque vous utilisez 
les outils Présentation 3D, vous déplacez la caméra activée.
Pour réinitialiser votre caméra, procédez de l’une des manières suivantes :
m Double-cliquez sur l’outil Balance, Orbite ou Travelling.
m Cliquez sur le menu Caméra (dans le coin supérieur gauche du Canevas), puis choisissez 
Réinitialiser la présentation.
m Dans l’onglet Propriétés de l’Inspecteur, cliquez sur le bouton Réinitialiser au sein 
des paramètres Transformation.
Utilisation d’objets en espace 3D
L’espace de travail 3D vous fournit divers outils de manipulation des objets en 3D. 
Ces outils comprennent les commandes 3D à l’écran qui servent à manipuler un objet 
directement, les commandes de transformation 3D de la palette et les paramètres 
de l’onglet Propriétés de l’objet sélectionné.
Pour transformer un objet en 3D:
1 Sélectionnez l’objet à transformer, puis cliquez sur l’icône Ajuster transformation 3D 
dans la barre d’outils.
Balance Travelling
Orbite
Caméra en cours de
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Des poignées d’échelle apparaissent sur le contour de l’objet, alors que trois poignées 
d’axe 3D de couleur sont affichées au niveau du point d’ancrage de l’objet. Chacune 
de ces poignées en forme de flèche correspond à l’axe le long duquel vous pouvez 
déplacer l’objet.
2 Faites glisser la poignée de transformation appropriée pour déplacer l’objet le long 
de l’axe sélectionné.
L’axe X (horizontal) est rouge, l’axe Y (vertical) vert et l’axe Z (profondeur) bleu.
Pour faire pivoter un objet en 3D:
1 Sélectionnez l’objet à transformer, puis cliquez sur l’icône Ajuster transformation 3D 
dans la barre d’outils.
Des poignées d’échelle apparaissent sur le contour de l’objet, alors que trois poignées 
d’axe 3D de couleur sont affichées au niveau du point d’ancrage de l’objet. Les trois 
petits cercles situés à proximité des poignées d’axe sont des poignées de rotation 3D. 
Chacune de ces poignées de rotation correspond à l’axe autour duquel vous pouvez 
faire pivoter l’objet.
2 Placez le pointeur au-dessus de l’une des trois poignées de rotation situées de chaque 
côté ou au-dessus des flèches de couleur.
Â Le cercle rouge indique une rotation autour de l’axe X.
Â Le cercle vert indique une rotation autour de l’axe Y.
Â Le cercle bleu indique une rotation autour de l’axe Z.
Poignées d’axe 3D représentées 
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3 Une fois que l’une des poignées de rotation 3D est activée, faites-la glisser vers 
la gauche ou la droite sur le Canevas pour appliquer une rotation à l’objet autour 
de l’axe sélectionné.
Pour réinitialiser un objet transformé :
1 Sélectionnez l’objet à réinitialiser.
Dans l’onglet Propriétés de l’Inspecteur, cliquez sur le bouton Réinitialiser au sein 
des paramètres Transformation.
Pour en savoir plus sur le travail en 3D et l’utilisation des outils de transformation 3D 
disponibles dans la palette, voir « compositing 3D » dans le manuel Motion Supplemental Documentation PDF.
Les poignées de rotation 3D vous aident à 
sélectionner un axe.
Au fur et à mesure de la rotation, une petite 
fenêtre d’information vous affiche les valeurs 
modifiées.
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Lecture de votre projet
Utilisez les commandes de lecture, situées en bas du Canevas, pour visionner votre 
projet et voir comment il évolue dans le temps. Vous pouvez mettre la lecture en 
boucle ou définir les points d’entrée et de sortie de la lecture pour votre projet. 
Vous pouvez activer et désactiver l’audio.
Lecture/Pause : démarre et met en pause la lecture. La touche de raccourci clavier 
correspondante est la barre d’espace.
Lecture en boucle : permet de déterminer si la lecture est en boucle ou si elle s’arrête 
à la fin de la plage de lecture. Le raccourci clavier correspondant est Maj + L. Pour en 
savoir plus sur le réglage de la plage de lecture d’un projet, voir « Définition de la plage 
de lecture » à la page 394.
Lire depuis le début : lit le projet à partir du point d’entrée de la plage de lecture 
jusqu’au point de sortie de la plage de lecture. Vous pouvez ainsi ne visionner qu’une 
partie du projet. Pour en savoir plus sur la définition des points d’entrée et de sortie, 
voir « Définition de la plage de lecture » à la page 394.
Aller au début du projet : renvoie automatiquement la tête de lecture au début 
du projet. Le raccourci clavier correspondant est la touche Début.
Aller à la fin du projet : déplace automatiquement la tête de lecture à la fin du projet. 
Le raccourci clavier correspondant est la touche Fin.
Reculer d’une image : recule la tête de lecture d’une image. Si vous cliquez sur ce 
bouton (ou maintenez la touche de raccourci clavier enfoncée), le projet est rembobiné 
d’une image à la fois. Le raccourci clavier correspondant est la touche Flèche gauche 
(ou Page préc.).
Avancer d’une image : avance la tête de lecture d’une image. Si vous cliquez sur 
ce bouton (ou maintenez la touche de raccourci clavier enfoncée), le projet avance 
d’une image à la fois. Le raccourci clavier correspondant est la touche Flèche droite 
(ou Page suiv.).
Lire/désactiver l’audio : active ou désactive le son.
Aller au début du projet Avancer d’une image
Aller à la fin du projet Reculer d’une image
Lire depuis le début Lecture en boucle
Lecture/Pause
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Remarque : la désactivation du son peut améliorer les performances de lecture.
Enregistrer: active ou désactive l’enregistrement de l’animation. Si l’enregistrement 
est activé, tous les curseurs des paramètres susceptibles d’être animés apparaissent en 
rose dans l’Inspecteur, ce qui vous rappelle que toute modification effectuée (telle que 
le déplacement d’un objet dans le Canevas ou le réglage d’un curseur) a pour effet 
de créer des images clés.
Remarque : lorsque l’option « Enregistrer les images clé sur les paramètres animés 
seulement » est activée dans la zone de dialogue Options d’enregistrement, les images 
clés sont ajoutées uniquement aux paramètres animés. Pour en savoir plus, voir 
« Enregistrement d’images clés sur les paramètres animés uniquement » à la page 613.
Preview RAM
Lorsque vous visionnez votre projet, Motion effectue des calculs complexes afin 
de représenter les objets et les effets qui apparaissent dans chaque image. Ce processus s’appelle le rendu. Le projet est lu aussi vite que possible à la fréquence d’images 
spécifiée dans la zone de dialogue Propriétés du projet. La fréquence d’images des 
projets très complexes risque d’être considérablement réduite, rendant ainsi très difficile d’obtenir un aperçu fidèle de l’aspect du projet lorsqu’il est lu à vitesse normale.
Vous pouvez rendre certaines portions de votre projet et stocker ces images en mémoire 
RAM. Ce procédé permet de visionner votre projet à la vitesse normale. C’est ce que l’on 
appelle le Preview RAM. Vous pouvez choisir de rendre la plage de lecture, une sélection 
ou la totalité du projet (option Tout). Au fur et à mesure que les images sont rendues, une 
zone de dialogue indique l’image en cours de traitement, le nombre d’images restantes 
et une estimation de la durée restante.
Vous pouvez interrompre le Preview RAM en cliquant sur le bouton Arrêter. La section 
ayant déjà été rendue est alors stockée en mémoire RAM. 
Remarque : comme les diverses parties du projet peuvent présenter différents niveaux 
de complexité, la valeur Temps restant ne constitue qu’une estimation.
Pour effectuer le Preview RAM de la totalité de votre projet :
m Choisissez Marquer > Preview RAM > Tout.
La zone de dialogue Preview RAM s’ouvre pour afficher une barre de progression. 
Elle se referme une fois que le Preview RAM a été effectué.Chapitre 1 Premiers contacts avec Motion 67
Lorsqu’une partie de votre projet est stocké en mémoire RAM, la Timeline et la miniTimeline adoptent la couleur verte pour indiquer les images stockées.
Zones de Preview RAM
La prévisualisation de grandes parties de votre projet via la fonction Preview RAM 
requiert une quantité importante de mémoire RAM pour stocker les images. Il se peut 
que vous ne disposiez pas de la quantité nécessaire pour stocker toutes les images 
à prévisualiser. Vous pouvez limiter le nombre d’images à rendre en choisissant de 
ne rendre que la plage de lecture ou une sélection. L’utilisation de la fonction Preview 
RAM sur une sélection a pour effet de rendre toutes les couches visibles du projet, 
depuis la première image de la sélection jusqu’à la dernière.
Pour effectuer le Preview RAM de la plage de lecture :
m Choisissez Marquer > Preview RAM > Plage de lecture.
La zone de dialogue Preview RAM s’ouvre pour afficher une barre de progression. 
Elle se referme une fois que le Preview RAM a été effectué.
Pour effectuer le Preview RAM d’une sélection :
1 Dans la Timeline, faites glisser le pointeur sur la zone à prévisualiser tout en maintenant 
les touches Commande + Option enfoncées.
Une bande bleu clair apparaît sur les images sélectionnées.
Pour en savoir plus sur les zones, voir « Utilisations des régions » à la page 395.
2 Choisissez Marquer > Preview RAM > Sélection.
Indicateurs de Preview 
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La zone de dialogue Preview RAM s’ouvre. Elle se referme une fois que le Preview RAM 
a été effectué.
Remarque : l’utilisation du mode en virgule flottante n’a aucun effet sur le Preview 
RAM. Bien que le projet soit rendu en mode virgule flottante, la prévisualisation sur 
le moniteur fait l’objet d’une conversion en 8 bits.
Effacement du Preview RAM
Vous pouvez supprimer manuellement un Preview RAM pour faire place à une nouvelle 
prévisualisation ou pour libérer de la mémoire RAM pour d’autres opérations.
Pour effacer le Preview RAM :
m Choisissez Marquer > Preview RAM > Effacer le Preview RAM.
Mini-Timeline
La mini-Timeline est affichée juste au-dessus des commandes de lecture, sous le Canevas. 
Cette commande permet de voir en un coup d’œil où se trouvent les objets sélectionnés 
dans votre projet. La mini-Timeline possède également une tête de lecture pour indiquer 
l’image en cours de lecture, ainsi que des marqueurs d’entrée et de sortie pour identifier 
la plage de lecture. La longueur de la mini-Timeline représente la durée totale du projet.
Vous pouvez faire glisser la tête de lecture à travers la mini-Timeline pour faire défiler votre 
projet ou accéder directement à un moment particulier. Vous pouvez également modifier 
la plage de lecture ou les points d’entrée et de sortie d’une couche en faisant glisser les 
marqueurs d’entrée et de sortie. Lorsque vous faites glisser un point d’entrée ou de sortie, la tête de lecture est temporairement déplacée au niveau du pointeur. Vous pouvez 
ainsi visionner l’image sur laquelle votre point d’entrée et de sortie sera défini. Dès que 
vous relâchez le bouton de la souris, la tête de lecture revient à sa position antérieure.
Les marqueurs de projet définis dans la Timeline sont indiqués dans la mini-Timeline 
par une fine ligne grise. Pour en savoir plus sur les marqueurs de projet et d’objet, 
voir « Ajout de marqueurs » à la page 398.
Remarque : les marqueurs d’objet n’apparaissent pas dans la mini-Timeline.
Point d’entrée Tête de lecture Point de sortie
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Montage dans la mini-Timeline
La mini-Timeline vous permet d’exécuter de nombreuses fonctions de montage 
non linéaire. Vous pouvez notamment faire glisser des objets (des plans, des images 
ou des éléments enregistrés dans la Bibliothèque, comme des formes, du texte, des 
caméras, des lumières, etc.) directement de la fenêtre Utilitaire vers la mini-Timeline. 
Vous pouvez également déplacer des objets, leur appliquer un Trim et les faire coulisser, 
afin de modifier la partie de ces objets qui apparaît à un moment donné. Pour en 
savoir plus sur les fonctions de modification, telles que Déplacer, Trim et Coulisser, 
voir « Modification d’objets dans la Timeline » à la page 375.
Pour ajouter un objet dans la mini-Timeline :
1 Faites glisser l’objet du Navigateur vers la mini-Timeline. 
Au fur et à mesure que vous faites glisser les objets, une légende indique l’image 
sur laquelle votre opération de montage aura lieu.
2 Une fois arrivé à l’image souhaitée, relâchez le bouton de la souris. 
L’objet est ajouté au projet débutant à cette image.
Vous pouvez également ajouter simultanément plusieurs objets à la mini-Timeline. 
Vous pouvez choisir s’il faut ajouter les objets de manière séquentielle (l’un après 
l’autre) ou sous forme de composite (tous sur le même point dans le temps).
∏ Astuce : si la Timeline contient des marqueurs de projet, vous pouvez aligner l’objet 
importé sur un marqueur. Faites glisser la couche sur la mini-Timeline, puis relâchez 
le bouton de la souris dès qu’une barre noire apparaît au niveau du point d’alignement. 
Le point d’entrée de la couche correspond alors au marqueur de projet.
Pour ajouter plusieurs objets dans la mini-Timeline :
1 Faites glisser les objets du Navigateur vers la mini-Timeline.
Au fur et à mesure que vous faites glisser les objets, une légende indique l’image 
sur laquelle votre opération de montage aura lieu.
2 Tout en maintenant le bouton de la souris enfoncé, faites glisser le pointeur vers 
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Un menu déroulant s’ouvre.
3 Choisissez le type de montage souhaité dans le menu déroulant, puis relâchez 
le bouton de la souris.
Selon le type d’élément glissé sur la Timeline, ce menu peut comporter jusqu’à quatre 
options différentes. Pour en savoir plus sur le menu déroulant Timeline, voir « Ajout 
d’objets dans la Timeline » à la page 363.
Pour déplacer un objet dans le temps :
1 Sélectionnez l’objet à déplacer dans l’onglet Couches, la liste de couches de la Timeline 
ou le Canevas.
L’objet apparaît dans la mini-Timeline.
2 Dans la mini-Timeline, faites glisser l’objet vers la gauche ou la droite pour 
le repositionner dans le temps.
Une légende indique les nouveaux points d’entrée et de sortie de l’objet, ainsi que 
le changement par rapport à la position précédente.
3 Une fois arrivé à la position souhaitée, relâchez le bouton de la souris.
Pour raccourcir ou rallonger un objet:
1 Sélectionnez l’objet afin qu’il soit visible dans la mini-Timeline.
2 Placez le pointeur sur le bord de début ou de fin de l’objet. 
Le pointeur se transforme alors en pointeur de Trim.
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3 Faites glisser le bord de l’objet pour en modifier la durée. 
Une bulle d’aide indique les nouveaux points d’entrée ou de sortie, ainsi que l’ampleur 
du changement provoqué par votre opération de montage.
Remarque : vous n’êtes pas autorisé à appliquer un Trim à un objet dans le but de 
le rendre plus long que le nombre d’images disponibles dans le fichier de média 
correspondant, à moins que sa Condition de fin soit réglée sur Suspendre, Boucle 
ou Ping-Pong dans les commandes Contrôle du temps affichées par l’onglet Propriétés 
de l’Inspecteur.
Pour faire coulisser un objet dans la mini-Timeline :
1 Sélectionnez l’objet à modifier.
2 Placez le pointeur sur la partie principale de l’objet dans la mini-Timeline, puis appuyez 
sur la touche Option. 
Le pointeur se transforme alors en pointeur de coulissement.
3 Faites glisser le plan vers la gauche ou la droite pour utiliser une partie ultérieure 
ou antérieure du plan.
Une légende indique les nouveaux points d’entrée et de sortie.
Remarque : il est impossible de faire coulisser un plan tant que l’on n’a pas effectué 
de Trim sur ce plan. Pour en savoir plus, voir « Coulissement de plans » à la page 378.
Pour aligner la tête de lecture sur un marqueur de projet dans la mini-Timeline :
m Maintenez la touche Maj enfoncée tandis que vous faites glisser la tête de lecture 
dans la mini-Timeline.
Champs Timecode et Image actuelle
Il existe deux champs de timecode situés en bas du Canevas, à droite et à gauche 
des commandes de lecture. Le champ situé à gauche est le champ Sur l’image actuelle ; 
il indique l’image ou le numéro de timecode sur lequel est placé la tête de lecture. 
Vous pouvez déplacer cette dernière en modifiant la valeur du champ Sur l’image 
actuelle.
Début des médias Pointeur Coulisser Fin des 
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Le champ situé à droite est le champ Durée du projet. Ce champ indique la durée de votre 
projet actuel. Vous pouvez modifier la durée du projet en modifiant la valeur de 
ce champ. Si le signe deux points apparaît entre les secondes et les valeurs des images, 
il indique que des images sont actuellement ignorées (Drop Frames).
Ces deux champs peuvent être modifiés de plusieurs manières et affichés sous la forme 
de numéros d’images ou de valeurs de timecode à huit chiffres.
Pour modifier l’image actuelle ou la durée :
m Cliquez sur le champ, tapez une nouvelle valeur, puis appuyez sur Tab ou Retour afin 
de confirmer la saisie.
Pour augmenter ou diminuer l’image actuelle ou la durée d’une image à la fois :
m Cliquez sur la flèche vers la gauche ou vers la droite du champ que vous souhaitez 
modifier.
Remarque : vous pouvez également avancer ou reculer image par image la tête 
de lecture en appuyant sur Flèche gauche (ou Page préc.) pour reculer et sur Flèche 
droite (ou Page suiv.) pour avancer.
Pour changer la durée en secondes, minutes ou heures, saisissez ce qui suit dans 
le champ Durée du projet:
m Pour définir la durée en secondes, entrez un nombre de secondes suivi d’un point. 
Par exemple, pour créer un projet de 10 secondes, tapez 10. dans le champ, puis 
appuyez sur Retour.
m Pour définir la durée en minutes, entrez un nombre de minutes suivi de deux points. 
Par exemple, pour créer un projet de 10 minutes, tapez 10.. dans le champ, puis 
appuyez sur Retour.
m Pour définir la durée en heures, entrez un nombre d’heures suivi de trois points. 
Par exemple, pour créer un projet de 1 heure, tapez 1... dans le champ, puis appuyez 
sur Retour.
Cette procédure fonctionne aussi bien avec le timecode qu’avec les images.
Le signe deux points à cet endroit
indique des images ignorées
Flèche gauche Flèche droite
Curseur de valeur
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Pour avancer ou reculer d’un certain nombre de secondes, minutes ou heures, 
saisissez ce qui suit dans le champ Image actuelle :
m Pour avancer d’un certain nombre de secondes, saisissez le signe plus (+) suivi 
du nombre de secondes dont vous souhaitez avancer, puis un point. Par exemple, 
pour avancer de 2 secondes, tapez +2. dans le champ, puis appuyez sur Retour. 
Pour avancer de minutes, tapez deux points après le nombre, et pour avancer 
d’heures, tapez trois points après le nombre.
m Pour reculer d’un certain nombre de secondes, saisissez le signe moins (–) suivi 
du nombre de secondes dont vous souhaitez reculer, puis un point. Par exemple, 
pour reculer de 2 secondes, tapez –2. dans le champ, puis appuyez sur Retour. 
Pour reculer de minutes, tapez deux points après le nombre, et pour reculer 
d’heures, tapez trois points après le nombre.
Pour déplacer la tête de lecture vers une image spécifique :
m La sous-fenêtre Canevas ou Projet étant active, tapez le timecode ou numéro d’image 
souhaité dans le champ Image actuelle. Appuyez sur Retour afin de confirmer la saisie.
Pour avancer d’un nombre spécifique d’images :
m Saisissez le signe plus (+) suivi du nombre d’images dont vous souhaitez avancer.
Pour reculer d’un nombre spécifique d’images :
m Saisissez le signe moins (–) suivi du nombre d’images dont vous souhaitez reculer. 
Pour modifier l’image actuelle ou la durée de manière dynamique :
m Cliquez dans la zone centrale du champ (zone contenant les nombres), puis faites glisser 
le pointeur vers la gauche pour augmenter la valeur ou vers la droite pour la diminuer. 
Faire glisser le champ Sur l’image actuelle de cette manière revient à faire glisser la tête 
de lecture le long de la mini-Timeline.
Pour alterner entre les numéros d’image et les valeurs de timecode, procédez 
de l’une des manières suivantes :
m Cliquez sur l’icône Sur l’image actuelle située directement à gauche du champ 
Sur l’image actuelle.
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m Cliquez sur l’icône Durée qui se trouve juste à gauche du champ Durée du projet.
Le fait de cliquer sur l’une ou l’autre de ces icônes alterne entre l’affichage des numéros 
d’image et des valeurs de timecode pour toutes les commandes des projets ouverts. 
Sous-fenêtre Projet
Lorsque vous vous attaquez à des projets plus complexes, vous pouvez visualiser leurs 
composants sous forme de liste, ce qui vous permet de consulter et modifier la hiérarchie des objets, notamment en regroupant des couches et en modifiant l’ordre des 
groupes. Vous pouvez alors désactiver temporairement certains objets et effets pour 
simplifier votre composition. Vous avez même la possibilité de visualiser et modifier 
les fichiers de médias associés aux couches de votre projet. Qui plus est, vous pouvez 
modifier certains attributs des couches et des groupes, tels que l’opacité, le mode de 
fusion et les niveaux audio. 
Icône Durée
Affichage du temps
Motion vous propose deux méthodes pour afficher les numéros d’image de votre 
projet. Vous pouvez afficher le temps sous forme d’images incrémentielles, allant 
de 1 ou 0 jusqu’à l’infini. La méthode alternative consiste à utiliser le système vidéo 
standard des valeurs de timecode, qui utilise une notation semblable à celle des 
chronomètres, en partant de 00:00:00:00 jusqu’à 23:59:59:29. Les deux premiers 
chiffres représentent les heures, les deux suivants, les minutes, les deux suivants, 
les secondes et les deux derniers chiffres, les images (HH:MM:SS:II).
Certains formats de timecode sautent des chiffres pour mieux refléter les imprécisions 
de fréquences d’images de certains formats vidéo.
Les modes d’affichage en images et en timecode possèdent chacun des avantages, 
en fonction principalement du format d’origine et du format final. Si vous êtes, par 
exemple, en train de créer une séquence de titre pour un film en 35 mm, qui doit 
contenir exactement 720 images, il est préférable de régler vos compteurs sur 
un affichage en numéros d’images.
Si vous êtes en train de réaliser un spot télévisé destiné à être diffusé ou transféré 
sur bande vidéo, vous devriez probablement régler vos compteurs sur un affichage 
en timecode, afin que les numéros d’image correspondent aux numéros figurant sur 
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Tout cela peut être effectué via la sous-fenêtre Projet, située généralement à gauche 
du Canevas. 
Pour afficher la sous-fenêtre Projet, effectuez l’une des opérations suivantes :
m Cliquez sur l’icône Projet dans la barre d’outils.
m Appuyez sur la touche F5.
m Faites glisser la barre de séparation sur le bord gauche du Canevas.
Vous pouvez également changer la disposition des fenêtres afin que la sous-fenêtre 
projet soit affichée à droite du Canevas.
Pour intervertir le Canevas et la sous-fenêtre Projet:
m Choisissez Fenêtre > Présentations > Intervertir la fenêtre du projet et le Canevas.
La sous-fenêtre Projet comporte trois onglets : Couches, Média et Audio. Chacun de 
ces onglets permet de visualiser des éléments de votre projet sous forme de liste.
Onglet Couches
L’onglet Couches de la sous-fenêtre Projet fournit une vue d’ensemble des couches, 
effets et masques actuellement utilisés dans votre projet. La hiérarchie des éléments 
de la liste décrit la manière dont les objets sont superposés dans le Canevas. Tous les 
objets, à l’exception des caméras et des lumières, doivent être intégrés à des groupes. 
Les masques, comportements et effets s’appliquent à des groupes ou à des couches 
particulières. D’ailleurs, une fois appliqués, ils sont répertoriés en dessous du groupe 
ou de la couche qu’ils affectent, avec un léger décalage sur la droite.76 Chapitre 1 Premiers contacts avec Motion
Les colonnes Nom et État de la liste de couches affichent diverses icônes représentant 
les éléments audio liés, la version 2D/3D ou le verrouillage. Par défaut, cette liste affiche 
également les masques, comportements et filtres appliqués. Vous pouvez activer 
et désactiver l’affichage de ces objets dans l’onglet Couches.
Pour afficher l’onglet Couches, procédez de l’une des manières suivantes :
m Cliquez sur l’icône Projet dans la barre d’outils.
m Choisissez Fenêtre > Couches.
m Appuyez simultanément sur les touches Commande + 4.
m Si la sous-fenêtre Projet est déjà affichée, cliquez sur l’onglet Couches situé en haut.
Les informations sont affichées dans une colonne et de nombreuses commandes 
permettent de personnaliser le mode de présentation pendant que vous êtes en train 
de travailler. Vous pouvez redimensionner et réarranger les colonnes, masquer certaines 
colonnes et afficher celles qui ne sont pas visibles par défaut.
L’onglet Couches contient les colonnes suivantes :
Activé : contient une case d’activation qui permet d’activer ou de désactiver la visibilité 
de l’objet. Quand la visibilité de l’objet est désactivée, il est toujours possible de modifier 
les paramètres de l’objet et de manipuler ses commandes à l’écran.Chapitre 1 Premiers contacts avec Motion 77
Preview : affiche l’objet sous forme de vignette. La vignette d’un groupe représente 
le résultat cumulé du travail de montage composite jusqu’à ce point du projet.
Nom : correspond au nom de l’objet. Pour modifier un nom, double-cliquez sur la zone 
de texte de l’objet sélectionné, saisissez un nouveau nom, puis appuyez sur Retour. 
Dans les projets contenant une caméra, le bouton Isoler apparaît dans cette colonne.
Bouton Isoler : ce bouton n’apparaît que dans les projets contenant une caméra. 
Lorsque vous ajoutez une caméra à un projet, tous ses groupes sont convertis en 3D 
(si vous cliquez sur Basculer en 3D dans la zone de dialogue Nouvelle caméra). 
En revanche, si vous cliquez sur Conserver en 2D dans la zone de dialogue Nouvelle 
caméra, une caméra est ajoutée à votre projet, mais tous les groupes restent en 2D. 
Une fois la caméra ajoutée au projet, le bouton Isoler est affiché pour le groupe, 
la couche ou la caméra sélectionné.
Ce bouton peut être activé ou désactivé. Si vous cliquez dessus pour une couche 
ou un groupe, vous restaurez l’orientation de face et vers l’avant d’origine de l’objet 
correspondant (vous pouvez ainsi lui appliquer un masque, par exemple). Cliquez à 
nouveau dessus pour revenir à l’affichage précédent. Si vous cliquez dessus pour 
une caméra, vous accédez à l’affichage de cette caméra.
Remarque : si vous isolez un groupe ou une couche, son nom remplace la liste des 
caméras actuelles dans le menu Caméra (dans le coin supérieur gauche du Canevas).
État: contient un certain nombre d’icônes indiquant l’état du projet. L’icône Verrouiller 
vous permet par exemple de verrouiller un objet afin d’empêcher toute modification sur cet 
objet. Le verrouillage d’un groupe empêche les modifications sur toutes les couches qu’il 
contient et les effets au sein de ce groupe. Cette colonne peut également afficher l’icône 
Lier si une couche comporte un élément audio, tel qu’un fichier QuickTime multicanal.
Cliquez ici pour afficher des colonnes 
supplémentaires
Icône de lien
Icône 2D/3D (réglée sur 2D)
Icône 3D (réglée sur 3D)
Bouton Isoler (activé)
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La colonne État contient aussi une icône 2D/3D qui permet de basculer un groupe 2D 
en 3D et inversement. La même icône apparaît immédiatement à gauche du nom 
du groupe pour indiquer l’état 2D/3D de ce groupe. Des couches ne peuvent pas être 
définies en 2D ou en 3D : elles ne constituent que des éléments 2D au sein de groupes 
2D ou 3D.
Il est possible d’afficher des colonnes supplémentaires en cliquant sur le signe 
supérieur, à droite des en-têtes de colonne. Un menu local contenant trois éléments 
apparaît : Preview, Opacité et Fusion.
Les coches du menu local signalent quelles sont les colonnes affichées. Par défaut, 
seule la colonne Preview est cochée. Choisissez les autres éléments à ajouter dans 
l’onglet Couches. Si vous choisissez un élément déjà coché, vous le masquez.
Opacité : affiche le niveau d’opacité actuel (transparence) du groupe ou de la couche. 
Ajustez le curseur pour modifier l’opacité de l’élément.
Remarque : la palette et l’onglet Propriétés de l’Inspecteur vous permettent également 
de régler l’opacité.
Mode de fusion : affiche le mode de fusion actuel du groupe ou de la couche. 
Cliquez sur le menu local pour choisir un autre mode de fusion. Pour en savoir plus 
sur les modes de fusion, voir « Utilisation des modes de fusion » à la page 322.
Remarque : vous pouvez également modifier le mode de fusion en cliquant sur 
un élément tout en maintenant la touche Contrôle enfoncée dans l’onglet Couches 
(ou la liste de couches de la Timeline), la palette ou l’onglet Propriétés de l’Inspecteur.Chapitre 1 Premiers contacts avec Motion 79
Modification des colonnes
Toute fenêtre contenant des colonnes de données peut être réorganisée en fonction 
de vos besoins. Vous pouvez modifier l’ordre d’affichage des colonnes ainsi que la taille 
des cellules. Vous pouvez, par exemple, modifier l’onglet Couches afin que la colonne 
prévisualisation y soit affichée à droite de la colonne Nom plutôt qu’à gauche. 
Vous pouvez également trier les éléments de la colonne par type de fichier.
Pour réorganiser les colonnes :
m Faites glisser l’en-tête de la colonne vers la gauche ou la droite à un nouvel emplacement.
Vous disposez de plusieurs méthodes pour redimensionner les colonnes. Vous pouvez 
régler la largeur d’une colonne ou modifier simultanément la hauteur de toutes 
les cellules des colonnes, y compris toutes les icônes et le texte qu’elles contiennent.
Pour ajuster la largeur d’une colonne :
m Dans la ligne d’en-tête, faites glisser la bordure d’une colonne afin de modifier sa largeur.
Pour ajuster la hauteur des cellules :
m Placez le pointeur au-dessus de n’importe quelle ligne horizontale, puis faites-la glisser vers 
le haut ou vers le bas afin de diminuer ou d’augmenter la hauteur de toutes les cellules.
Les icônes et les vignettes sont automatiquement redimensionnées au fur et à mesure 
que vous effectuez ces réglages.
Vous pouvez également faire glisser le curseur d’échelle situé en bas de la fenêtre. 
Faites-le glisser vers la gauche pour diminuer la hauteur des cellules et vers la droite 
pour l’augmenter.
Ajout et suppression de groupes
L’onglet Couches contient des commandes permettant d’ajouter de nouveaux groupes 
et de supprimer certains objets du projet.
Pour créer un nouveau groupe dans la liste de couches, procédez de l’une 
des manières suivantes :
m Cliquez sur le bouton Ajouter (+) dans l’angle supérieur gauche de l’onglet.
m Choisissez Objet > Nouveau groupe (ou appuyez sur les touches Maj + Commande + N).
Un nouveau groupe vide est ajouté au haut de la liste.80 Chapitre 1 Premiers contacts avec Motion
Remarque : vous pouvez également créer de nouveaux groupes en faisant glisser 
des fichiers vers l’onglet Couches depuis le Navigateur ou la Bibliothèque. Pour en 
savoir plus, voir « Ajout de fichiers à votre projet » à la page 239.
Pour supprimer un objet de la liste de couches, procédez de l’une des manières 
suivantes :
m Sélectionnez l’objet à supprimer, puis cliquez sur le bouton Supprimer (–) dans le coin 
supérieur gauche de l’onglet.
m Appuyez sur la touche Contrôle tout en cliquant sur le fichier que vous voulez supprimer, 
puis choisissez Supprimer dans le menu contextuel.
m Sélectionnez le fichier à supprimer, puis choisissez Édition > Supprimer (ou appuyez 
sur Suppr).
L’objet est supprimé. Cette opération supprime également l’objet du Canevas.
Remarque : si vous supprimez un fichier de média (une image importée, une séquence 
d’images, un fichier audio ou une séquence QuickTime) du projet, ce fichier est également supprimé de l’onglet Média, à moins que l’option « Supprimer automatiquement 
les données inutilisées » ne soit désactivée dans la section Générales des préférences 
Motion (accessibles via Commande + virgule). Si cette option est effectivement désactivée, les fichiers de médias sont supprimés de l’onglet Couches (et du Canevas), mais 
restent au sein du projet dans l’onglet Média. Faites alors glisser un élément de l’onglet 
Média vers le Canevas pour l’ajouter à l’onglet Couches.
Filtrage de l’affichage de la liste de couches
À mesure que votre projet devient de plus en plus complexe, il se peut que vous soyez 
amené à masquer temporairement l’affichage de certains objets. Vous pouvez ainsi 
vous concentrer sur un ou plusieurs objets sans être distrait par tous les autres objets 
de la liste. Vous pouvez effectuer ce type de filtrage via le champ Rechercher situé dans 
l’angle supérieur droit de l’onglet.
Dès que vous commencez à taper du texte dans le champ Rechercher, la liste de couches 
masque tous les objets qui ne contiennent pas le texte que vous êtes en train de taper. 
Les objets masqués demeurent toutefois affichés dans le Canevas.
Pour filtrer la liste de couches :
m Saisissez le nom du ou des objets que vous souhaitez afficher dans le champ de recherche. 
Tous les autres objets sont temporairement masqués.
Champ de rechercheChapitre 1 Premiers contacts avec Motion 81
Pour arrêter le filtrage et rétablir la liste complète :
m Cliquez sur le bouton Effacer dans le champ Rechercher. 
Le contenu du champ Rechercher est effacé et la liste de couches complète est rétablies.
Affichage et masquage des effets
Les masques, comportements et filtres peuvent être activés et désactivés dans la liste 
de couches, à l’aide des boutons qui se trouvent dans l’angle inférieur droit de l’onglet 
Couches. 
Remarque : même si vous masquez un effet dans la liste de couches, il reste visible 
dans le Canevas et vous pouvez toujours modifier ses paramètres ou manipuler ses 
commandes à l’écran.
Pour activer/désactiver l’affichage des masques dans l’onglet Couches :
m Cliquez sur le bouton Afficher les masques.
Pour activer/désactiver l’affichage des comportements dans l’onglet Couches :
m Cliquez sur le bouton Afficher les comportements.
Pour activer/désactiver l’affichage des filtres dans l’onglet Couches :
m Cliquez sur le bouton Afficher les filtres. 
Afficher les comportements
Afficher 
les masques
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Activation et désactivation des effets
Lorsque certains effets sont appliqués à une couche ou un groupe, des icônes apparaissent 
dans la colonne Nom de cet élément. Vous pouvez ainsi savoir qu’un effet est appliqué, 
surtout si vous avez masqué les effets. Il existe des icônes pour les masques, les filtres 
et les comportements. Ces icônes vous permettent en outre d’activer et de désactiver 
les effets dans le Canevas.
Remarque : vous pouvez également cliquer sur les icônes tout en maintenant la touche 
Contrôle enfoncée sous l’onglet Couches ou dans la liste de couches de la Timeline 
pour afficher une liste des effets appliqués.
Pour désactiver les masques d’une couche ou d’un groupe :
m Cliquez sur l’icône Masque.
Une barre rouge apparaît sur l’icône et l’effet est temporairement désactivé.
Pour désactiver les comportements d’une couche ou d’un groupe :
m Cliquez sur l’icône Comportement. 
Une barre rouge apparaît sur l’icône et l’effet est temporairement désactivé.
Pour désactiver les filtres d’une couche ou d’un groupe :
m Cliquez sur l’icône Filtre. 
Une barre rouge apparaît sur l’icône et l’effet est temporairement désactivé.
Pour chacune de ces commandes, le fait de cliquer à nouveau sur l’icône permet 
de réactiver l’effet.
Autres options disponibles dans l’onglet Couches
L’onglet Couches et la liste de couches de la Timeline proposent un certain nombre 
de fonctions supplémentaires, accessibles via le menu contextuel affiché lorsque vous 
cliquez sur des couches de la liste tout en maintenant la touche Contrôle enfoncée. 
Ces fonctions s’appliquent à l’élément sélectionné.
Filtre désactivé
Masques
Comportements
Filtres
Isoler (désactivé)Chapitre 1 Premiers contacts avec Motion 83
Couper : supprime la couche et la place dans le Presse-papiers.
Copier : copie la couche dans le Presse-papiers.
Coller : place le contenu du Presse-papiers à l’emplacement actuel.
Dupliquer : crée une nouvelle couche identique à la sélection.
Supprimer : supprime la couche sélectionnée.
Grouper : place les couches sélectionnées dans un groupe. (Pour en savoir plus 
sur l’utilisation des groupes, voir « Regroupement et dissociation de couches » à la 
page 269.)
Dissocier : rétablit l’état antérieur non groupé des éléments si la sélection comprend 
un groupe.
Activer : active ou désactive la couche. Cela revient à cocher la case d’activation dans 
la colonne Act.
Solo : l’application de cette commande à une couche masque toutes les autres couches 
du projet. Lorsque l’élément sélectionné est en solo, les cases à cocher des autres couches 
et groupes sont estompées. Vous pouvez activer le mode solo pour plusieurs couches 
et groupes simultanément.
Isoler : disponible si un projet contient une caméra, cette option isole la couche, 
le groupe ou la caméra sélectionné. Si vous choisissez Isoler pour une couche 
ou un groupe, vous restaurez l’orientation de face et vers l’avant d’origine de l’objet 
correspondant (vous pouvez ainsi lui appliquer un masque, par exemple). Si vous cliquez 
sur le bouton Isoler d’une caméra, vous activez l’affichage de cette caméra. L’activation 
de cette option revient à cliquer sur l’icône Isoler dans la colonne Nom.
Groupe 3D : convertit le groupe sélectionné en groupe 2D ou 3D.
Mode de fusion : définit le mode de fusion de la couche sélectionnée. Cela revient 
à définir une valeur dans la colonne Fusion.
Ajouter un masque d’image : ajoute un masque d’image à la couche sélectionnée. 
En effet, un masque d’image crée de la transparence dans un autre objet en utilisant 
le canal alpha d’une autre couche, telle qu’une forme, du texte, une séquence ou une 
image fixe. Pour en savoir plus, voir « Application de masques d’image à une couche » 
à la page 1190.
Cloner la couche : clone la couche sélectionnée. Comme la commande Dupliquer, 
Cloner la couche vous permet de créer des copies de la couche sélectionné. Toutefois, 
les copies créées au moyen de la commande Cloner la couche sont automatiquement 
mises à jour pour refléter certaines modifications apportées à la couche d’origine. Pour 
en savoir plus sur le clonage des couches, voir « Clonage de couches » à la page 315.
Afficher le média source : ouvre l’onglet Média et met en surbrillance le fichier 
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Onglet Média
Le deuxième onglet de la sous-fenêtre Projet affiche une liste complète des médias 
de votre projet. Un « média » est en fait un fichier audio, une image, une séquence d’images ou une séquence QuickTime importé. Contrairement à l’onglet Couches, l’onglet 
Média peut afficher des éléments qui ne sont pas utilisés dans votre projet. De plus, si 
vous avez utilisé plusieurs fois la même couche, il se peut que l’onglet Média n’affiche 
qu’une seule version de cette couche. Les effets (filtres ou masques) et les autres couches 
créées dans Motion (masques, formes ou texte) n’apparaissent pas dans l’onglet Média.
Pour afficher l’onglet Média, procédez de l’une des manières suivantes :
m Choisissez Fenêtre > Média.
m Appuyez simultanément sur les touches Commande + 5.
m Si la sous-fenêtre Projet est déjà affichée, cliquez sur l’onglet Média en haut de la fenêtre.
m Pour afficher des colonnes supplémentaires dans l’onglet Média, faites glisser la ligne 
de séparation entre la sous-fenêtre Projet et le Canevas (la ligne verticale le long 
du bord droit de la fenêtre).
L’onglet Média fournit un grand nombre d’informations techniques sur les fichiers de 
médias de votre projet. Pour chaque fichier, ces données sont affichées dans les colonnes 
suivantes :
Preview : affiche le fichier de média sous forme de vignette. La vignette d’un fichier 
audio (sans image associée) représente l’icône d’un haut-parleur.
Nom : contient le nom du média. Ces noms ne sont pas modifiables, car ils font référence 
aux fichiers stockés sur le disque dur.
Type : identifie le type de média (tel que séquence QuickTime, image fixe, audio 
QuickTime ou PDF). Pour une liste des codecs et des types de fichiers pris en charge, 
voir l’annexe B, « Formats vidéo et de fichiers », à la page 1293.
En service : si une coche apparaît dans cette colonne, le média est actuellement utilisé dans votre projet. En l’absence de coche, le média n’est pas utilisé. Si l’option 
« Supprimer automatiquement les données inutilisées » est activée dans l’onglet Géné-
rales des préférences Motion (accessibles via Commande + virgule), Motion supprime 
automatiquement les médias inutilisés de l’onglet Média. Désactivez cette option 
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Durée : affiche la durée du média en images ou en timecode.
Dim. image : affiche les dimensions natives de l’image, exprimées en pixels. Les nombres 
représentent la largeur et la hauteur. Cette colonne demeure vide pour les fichiers ne 
contenant que des données audio.
Compresseur : affiche le type de compression éventuel utilisé dans le plan. On utilise 
parfois le terme codec.
Profondeur : affiche le nombre de couleurs (profondeur de bits) du fichier. La mention 
« Millions de couleurs + » indique que le média contient un canal alpha en plus 
des données RVB.
Fréquence d’images : affiche le nombre original d’images par secondes du média. 
Les séquences sont répertoriées à la fréquence d’images actuelle du projet 
et les images fixes n’affichent pas de fréquence d’images.
Débit : affiche la vitesse de lecture du fichier de média, exprimée en nombre d’octets 
par seconde.
Échantillonnage : affiche la fréquence d’échantillonnage de la piste audio, exprimée 
en kilohertz (kHz).
Format audio : affiche le nombre de bits par échantillon (généralement 8, 16 ou 24) 
et le nombre de canaux (mono, stéréo ou multicanal) de la piste audio.
Taille fichier : affiche la taille totale occupée par le fichier du média sur le disque.
Fichier créé le : affiche la date de création du média.
Fichier modifié le : affiche la dernière date de modification du média.
Masquage des colonnes
Vous pouvez choisir les colonnes à afficher en cliquant sur le signe supérieur situé 
à droite des en-têtes de colonnes.
Les éléments cochés de la liste indiquent qu’ils sont affichés dans l’onglet Média. 
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Pour masquer une colonne :
m Cliquez sur le signe supérieur, à droite des en-têtes de colonnes, puis choisissez 
l’élément à masquer dans le menu local.
Pour afficher une colonne :
m Cliquez sur le signe supérieur, à droite des en-têtes de colonnes, puis choisissez 
l’élément à afficher dans le menu local.
L’élément apparaît à droite de toutes les colonnes.
Toute fenêtre contenant des colonnes de données peut être réorganisée. Vous pouvez 
modifier l’ordre d’affichage des colonnes ainsi que la taille des cellules. Vous pouvez, 
par exemple, modifier l’onglet Média afin que la colonne « Dim. image » y soit affichée 
avant la colonne Nom. Pour en savoir plus sur la modification des colonnes, 
voir « Modification des colonnes » à la page 79.
Ajout et suppression de médias
L’onglet Média contient des commandes permettant d’ajouter de nouveaux fichiers 
à votre projet et d’en supprimer.
Pour ajouter un fichier dans l’onglet Média, procédez de l’une des manières 
suivantes :
m Cliquez sur le bouton Ajouter (+) dans l’angle supérieur gauche de l’onglet. Dans la zone 
de dialogue Importation de fichiers, accédez au fichier que vous souhaitez ajouter 
à votre projet, sélectionnez-le, puis cliquez sur Importer.
Remarque : pour importer une séquence d’images, cochez la case Séquence d’images. 
Dans le cas contraire, seul le fichier sélectionné dans la zone de dialogue Importation 
de fichiers est importé. Pour sélectionner plusieurs fichiers, cliquez sur leur nom tout 
en maintenant la touche Maj enfoncée. Pour sélectionner des fichiers non contigus, 
procédez de même, mais appuyez sur la touche Commande.
m Alors que l’onglet Média est activé, choisissez Fichier > Importer (ou appuyez 
sur les touches Commande + I). Dans la zone de dialogue Importation de fichiers, 
accédez au fichier que vous souhaitez ajouter à votre projet, sélectionnez-le, puis 
cliquez sur Importer.
Le fichier est ajouté à l’onglet Média.
Important : les fichiers ajoutés directement dans l’onglet Média ne sont pas ajoutés 
au Canevas. Pour ajouter un fichier au Canevas, faites-le ensuite glisser de l’onglet 
Média vers le Canevas.
Pour supprimer un fichier de l’onglet Média, procédez de l’une des manières 
suivantes :
m Sélectionnez le fichier à supprimer, puis cliquez sur le bouton Supprimer (–) dans 
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m Appuyez sur la touche Contrôle tout en cliquant sur le fichier, puis choisissez Supprimer 
dans le menu contextuel.
m Sélectionnez le fichier à supprimer, puis choisissez Édition > Supprimer (ou appuyez 
sur Suppr).
Le média est supprimé. Si ce média est utilisé dans le Canevas, un message vous invite 
de confirmer sa suppression.
Filtrage de l’onglet Média
Plus votre projet devient complexe, plus vous pouvez avoir envie de masquer temporairement l’affichage de certains fichiers. Vous pouvez ainsi vous concentrer sur un 
ou plusieurs fichiers sans être distrait par tous les autres fichiers de la liste. Vous pouvez 
effectuer ce type de filtrage via le champ Rechercher situé dans l’angle supérieur droit 
de l’onglet. Pour en savoir plus sur le filtrage de l’onglet Média, voir « Filtrage de 
l’affichage de la liste de couches » à la page 80.
Autres options disponibles dans l’onglet Média
L’onglet Média contient un certain nombre de fonctions supplémentaires, accessibles 
via le menu contextuel affiché lorsque vous cliquez sur un ou des fichiers de la liste 
tout en maintenant la touche Contrôle enfoncée. Les commandes de ce menu s’appliquent au(x) fichier(s) sélectionné(s).
Ouvrir dans le Visualiseur : ouvre l’élément sélectionné dans la fenêtre du Visualiseur, 
ce qui revient à double-cliquer sur un fichier dans le Navigateur.
Ouvrir dans QuickTime Player : ouvre l’élément sélectionné dans QuickTime Player.
Afficher dans le Finder : bascule hors de Motion et ouvre une fenêtre du Finder 
pour afficher l’emplacement du fichier de média sur le disque dur.
Reconnecter les médias : ouvre la zone de dialogue Reconnecter les médias 
dans laquelle vous pouvez affecter un nouveau fichier source du disque au fichier 
de données qui se trouve dans Motion.
Couper : supprime le fichier et le place dans le Presse-papiers.
Copier : copie le fichier dans le Presse-papiers.
Coller : place le contenu du Presse-papiers à l’emplacement actuel.
Dupliquer : crée un nouveau fichier identique au fichier sélectionné.
Supprimer : supprime le fichier sélectionné.
Si vous n’avez sélectionné aucun élément dans l’onglet, le menu contextuel propose 
d’autres commandes :
Importer des médias : importe des médias dans l’onglet Média, sans les placer 
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Reconnecter les médias manquants : si l’emplacement de stockage d’un fichier 
de média est modifié après son ajout à votre projet, vous devez reconnecter ce fichier 
à votre projet. Cette commande affiche une zone de dialogue qui vous permet 
d’accéder au nouvel emplacement du fichier.
Supprimer les données inutilisées : si votre projet contient des médias qui ne sont 
pas utilisés, utilisez cette commande pour supprimer rapidement tous les objets 
inutilisés de l’onglet Média.
Coller : colle dans l’onglet Média les fichiers de médias actuellement dans 
le Presse-papiers, sans les placer dans le Canevas.
Propriétés du projet : ouvre la zone de dialogue du même nom, qui vous permet 
de définir des informations de base sur votre projet, comme sa largeur et sa hauteur, 
la profondeur de bits, les proportions, la couleur d’arrière-plan, les réglages de rendu, etc. 
Pour en savoir plus sur la zone de dialogue Propriétés du projet, voir « Création de projets vierges à partir de préréglages de projet » à la page 201.
Pour trier une colonne selon le type de fichier dans l’onglet Média :
m Cliquez sur l’en-tête de colonne.
Remarque : le tri ne fonctionne pas dans l’onglet Couches ou la liste de couches 
de la Timeline.
Les couches sont triées dans la colonne et une petite flèche indique la direction du tri.
Cliquez sur l’en-tête de colonne 
afin de trier en fonction 
du type de données 
de cette colonne.
La flèche dans l’en-tête de 
la colonne indique la direction 
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Pour inverser la direction du tri :
m Cliquez sur l’en-tête de la colonne contenant la petite flèche.
La flèche pointe dans la direction opposée et les données sont triées dans l’ordre 
inverse.
Onglet Audio
L’onglet Audio dresse la liste de tous les fichiers audio et de tous les fichiers contenant 
des données audio (comme une séquence QuickTime multipiste) de votre projet. 
Vous pouvez y modifier les niveaux de certains fichiers ou le niveau audio général 
du projet. Pour en savoir plus sur l’utilisation de fichiers audio dans Motion, voir 
le chapitre 13, « Utilisation de données audio », à la page 1203.
Pour afficher l’onglet Audio, procédez de l’une des manières suivantes :
m Choisissez Fenêtre > Audio.
m Appuyez simultanément sur les touches Commande + 6.
m Si la sous-fenêtre Projet est déjà affichée, cliquez sur l’onglet Audio en haut de la fenêtre.
L’onglet Audio contient un certain nombre de colonnes qui affichent des informations 
modifiables ou non sur les composants audio de votre projet :
Activé : contient une case d’activation qui permet d’activer ou de désactiver 
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Nom : correspond au nom du fichier. Pour modifier un nom, double-cliquez sur la 
zone de texte du fichier sélectionné, saisissez un nouveau nom, puis appuyez sur 
Retour. Cette colonne contient également un curseur et un champ qui servent à contrôler le niveau (volume) du fichier. Les nombres qui apparaissent dans le champ sont 
exprimés en décibels (dB).
Balance : affiche la balance gauche-droite du son. Vous pouvez modifier ce paramètre 
en faisant glisser le curseur vers la droite ou vers la gauche ou en saisissant une valeur 
de balance numérique. Les valeurs négatives déplacent la balance vers la gauche ; 
les valeurs positives déplacent la balance vers la droite.
État: contient les boutons Activer/Désactiver le son et Solo pour contrôler la lecture 
audio du fichier. Lorsque le bouton Activer/Désactiver le son est activé, tout le son 
contenu dans le fichier est supprimé du mixage. Lorsqu’il est désactivé, les données 
audio du fichier sont lues en fonction du niveau indiqué par le curseur situé dans 
la colonne Nom.
Lorsque le bouton Solo est activé, les autres éléments audio non-solo ne sont pas lus, 
ce qui vous permet de lire un seul élément, sans avoir à écouter les autres fichiers 
de votre montage. De plus, vous pouvez appliquer l’option Solo à plusieurs fichiers. 
Ainsi, vous écoutez uniquement les fichiers marqués en solo, plutôt que l’ensemble 
du mixage.
Sortie : définit les canaux de sortie audio. Vous avez le choix entre : stéréo, gauche, droite, 
centre, etc. Cliquez sur ce champ pour choisir un canal de sortie pour la piste audio.
Verrouiller: vous permet de verrouiller un fichier audio, afin d’éviter qu’il ne soit modifié. 
Cette colonne peut également afficher une icône Lier lorsqu’un fichier est associé à 
un élément vidéo.
Modification des colonnes dans l’onglet Audio
Vous pouvez contrôler les colonnes à afficher en cliquant sur le signe supérieur, situé 
à droite des en-têtes de colonnes. Un menu local apparaît alors. Il dresse la liste des 
colonnes. Les éléments cochés de cette liste indiquent qu’ils sont affichés dans la fenê-
tre. Les éléments non cochés sont masqués. Vous pouvez également modifier la disposition et la taille des colonnes. Pour savoir comment procéder pour masquer et afficher 
des colonnes, voir « Masquage des colonnes » à la page 85. Pour en savoir plus sur 
la modification des colonnes, voir « Modification des colonnes » à la page 79.
Activer/Désactiver
le son
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Ajout et suppression de fichiers audio
L’onglet Audio contient des commandes permettant d’ajouter de nouveaux fichiers 
et de ne plus afficher certains fichiers de votre projet. 
Pour ajouter un fichier audio au projet, procédez de l’une des manières suivantes :
m Cliquez sur le bouton Ajouter (+) dans l’angle supérieur gauche de l’onglet. Dans 
la zone de dialogue Importation de fichiers, accédez au fichier que vous souhaitez 
importer, sélectionnez-le, puis cliquez sur OK.
m Alors que l’onglet Audio est activé, choisissez Fichier > Importer (ou appuyez sur 
les touches Commande + I). Dans la zone de dialogue Importation de fichiers, accé-
dez au fichier que vous souhaitez ajouter à votre projet, sélectionnez-le, puis cliquez 
sur Importer.
Remarque : lors de l’importation d’une séquence QuickTime contenant plusieurs pistes 
audio, sélectionnez l’option Mixer vers stéréo dans la zone de dialogue Importation de 
fichiers pour importer le fichier avec une seule piste audio. En revanche, sélectionnez 
Importer toutes les pistes pour importer le fichier avec ses différentes pistes. 
Le fichier est ajouté au projet (dans les onglets Audio et Média).
Pour supprimer un fichier de l’onglet Audio, procédez de l’une des manières 
suivantes :
m Sélectionnez le fichier à supprimer, puis cliquez sur le bouton Supprimer (–) dans 
le coin supérieur gauche de l’onglet.
m Appuyez sur la touche Contrôle tout en cliquant sur le fichier, puis choisissez Supprimer 
dans le menu contextuel.
m Sélectionnez le fichier à supprimer, puis choisissez Édition > Supprimer (ou appuyez 
sur Suppr).
Le fichier est supprimé. 
Remarque : ces méthodes suppriment le fichier du projet (des onglets Audio et Média).
Filtrage de l’onglet Audio
À mesure que votre projet devient de plus en plus complexe, il se peut que vous soyez 
amené à masquer temporairement l’affichage de certains fichiers audio. Vous pouvez 
ainsi vous concentrer sur un ou plusieurs fichiers sans être distrait par tous les autres 
fichiers de la liste. Vous pouvez effectuer ce type de filtrage via le champ Rechercher 
situé dans l’angle supérieur droit de l’onglet. Pour en savoir plus sur le filtrage de 
l’affichage, voir « Filtrage de l’affichage de la liste de couches » à la page 80.92 Chapitre 1 Premiers contacts avec Motion
Autres options disponibles dans l’onglet Audio
L’onglet Audio contient quelques fonctions supplémentaires accessibles via le menu 
contextuel qui apparaît lorsque vous cliquez sur les fichiers de la liste en maintenant 
la touche Contrôle enfoncée :
Couper : supprime le fichier et le place dans le Presse-papiers.
Copier : copie le fichier dans le Presse-papiers.
Coller : place le contenu du Presse-papiers à l’emplacement actuel.
Dupliquer : crée un nouveau fichier identique au fichier d’origine.
Supprimer : supprime le fichier sélectionné.
Envoyer vers Soundtrack Pro : lance Soundtrack Pro et ouvre le plan audio sélectionné dans Soundtrack Pro pour pouvoir le modifier.
Activer : active et désactive le fichier. Cela revient à cocher la case d’activation dans 
la colonne Act.
Activer/Désactiver le son : désactive le son de l’élément sélectionné. Cela revient 
à cliquer sur le bouton Activer/Désactiver le son dans la colonne État.
Solo : règle l’élément sélectionné sur Solo. Cela revient à cliquer sur le bouton Solo 
dans la colonne État.
Afficher le média source : ouvre l’onglet Média et met en surbrillance le fichier 
de média associé au plan sélectionné.
Si vous n’avez sélectionné aucun élément dans l’onglet Audio, le menu contextuel 
propose d’autres commandes.
Importer l’audio : ouvre la zone de dialogue Importation de fichiers, qui vous permet 
d’accéder au fichier audio que vous souhaitez importer.
Coller : colle toutes les données audio actuellement présentes dans le Presse-papiers 
vers les onglets Audio et Média.
Propriétés du projet : ouvre la zone de dialogue du même nom, qui vous permet 
de définir des informations de base sur votre projet, comme sa largeur et sa hauteur, 
la profondeur de bits, les proportions, la couleur d’arrière-plan, les réglages de rendu, etc. 
Pour en savoir plus sur la zone de dialogue Propriétés du projet, voir « Création de 
projets vierges à partir de préréglages de projet » à la page 201.Chapitre 1 Premiers contacts avec Motion 93
Fenêtre Contrôle du temps
Dans la majeure partie des projets, arrive un stade où il est nécessaire de visualiser 
le contenu de votre composition sous la forme d’un graphique temporel. Cela peut 
servir, par exemple, à comparer les moments où deux objets apparaissent ou disparaissent, 
ou les moments correspondant au début ou à la transformation d’un effet. En effet, 
vous pouvez tout à fait ajouter ou supprimer des objets dans votre projet à un point 
particulier dans le temps afin d’observer ou de modifier le comportement de plusieurs 
paramètres d’effets différents. Vous pouvez également visualiser vos formes d’onde 
audio pour permettre la synchronisation des éléments visuels avec votre bande-son.
Tout cela est possible via la fenêtre Contrôle du temps qui se trouve en bas du Canevas. 
Pour afficher la fenêtre Contrôle du temps, procédez de l’une des manières suivantes :
m Faites glisser la barre de séparation sur le bord inférieur du Canevas.
m Cliquez sur l’icône Contrôle du temps située dans l’angle supérieur droit du Canevas.
m Choisissez Fenêtre > Timeline (ou appuyez sur Commande + 7).
m Appuyez sur la touche F6.
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m Choisissez Fenêtre > Présentations > Cinéma (ou appuyez simultanément sur les touches 
Contrôle + Option + U).
La fenêtre Contrôle du temps comporte trois onglets : Timeline, Éditeur d’images clés 
et Éditeur audio. Chacun de ces onglets permet de visualiser les éléments de votre 
projet étalés dans le temps.
Timeline
La Timeline constitue l’onglet le plus général des onglets de contrôle du temps. 
Elle peut non seulement afficher les objets visuels de votre projet (les couches), 
mais aussi les pistes audio, les caméras, les lumières, les images clés et les effets 
(masques, comportements et filtres). Pour en savoir plus sur l’utilisation de la 
Timeline, consultez la rubrique « Utilisation de la Timeline » à la page 353.
Pour afficher l’onglet Timeline, procédez de l’une des manières suivantes :
m Choisissez Fenêtre > Timeline (ou appuyez sur Commande + 7).
m Si la sous-fenêtre Projet est déjà affichée, cliquez sur l’onglet Timeline en haut 
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Liste de couches de la Timeline
La partie gauche de la Timeline est réservée à une liste de couches pratiquement 
identique à la liste affichée par l’onglet Couches de la sous-fenêtre Projet. Les objets 
apparaissent dans la hiérarchie du projet, classés en couches et en groupes. Les trois 
colonnes sont identiques à celles de la liste de couches.
Activé (sans titre) : cette colonne (identique à la colonne Activé de l’onglet Couches) 
contient une case en regard de chaque objet, qui permet d’activer et de désactiver 
la visibilité de l’objet correspondant. Quand la visibilité de l’objet est désactivée, il est 
toujours possible de modifier les paramètres de l’objet et de manipuler ses commandes 
à l’écran.
Nom (sans titre) : correspond au nom de l’objet. (Cette colonne est identique à la 
colonne Nom de l’onglet Couches.) Pour modifier un nom, double-cliquez sur la zone 
de texte de l’objet sélectionné, saisissez un nouveau nom, puis appuyez sur Retour. 
Dans les projets contenant une caméra, le bouton Isoler apparaît également dans 
cette colonne.
Isoler : ce bouton n’apparaît que dans les projets contenant une caméra. Lorsque 
vous ajoutez une caméra à un projet, tous ses groupes sont convertis en 3D (si vous 
cliquez sur Basculer en 3D dans la zone de dialogue Nouvelle caméra). En revanche, 
si vous cliquez sur Conserver en 2D dans la zone de dialogue Nouvelle caméra, 
une caméra est ajoutée à votre projet, mais tous les groupes restent en 2D. Une fois 
la caméra ajoutée au projet, le bouton Isoler est affiché pour le groupe, la couche 
ou la caméra sélectionné.
Ce bouton peut être activé ou désactivé. Si vous cliquez dessus pour une couche 
ou un groupe, vous restaurez l’orientation de face et vers l’avant d’origine de l’objet 
correspondant (vous pouvez ainsi lui appliquer un masque, par exemple). Cliquez 
à nouveau dessus pour revenir à l’affichage précédent. Si vous cliquez dessus pour 
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État (sans titre) : contient un certain nombre d’icônes indiquant l’état du projet. 
(Cette colonne est identique à la colonne État de l’onglet Couches.) L’icône Verrouiller vous 
permet par exemple de verrouiller un objet afin d’empêcher toute modification sur cet 
objet. Le verrouillage d’un groupe empêche les modifications sur toutes les couches qu’il 
contient et les effets au sein de ce groupe. Cette colonne peut également afficher l’icône 
Lier si une couche comporte un élément audio, tel qu’un fichier QuickTime multicanal.
La colonne État contient aussi une icône 2D/3D qui permet de convertir un groupe 2D 
en 3D et inversement. La même icône apparaît immédiatement à gauche du nom 
du groupe pour indiquer l’état 2D/3D de ce groupe. Des couches ne peuvent pas être 
définies en 2D ou en 3D : elles ne constituent que des éléments 2D au sein de groupes 
2D ou 3D.
Remarque : toute modification effectuée dans la liste de couches de la Timeline 
modifie également la liste de couches de la sous-fenêtre Projet et vice versa.
Commandes relatives aux effets dans la liste de couches de la Timeline
Lorsque certains effets sont appliqués à un objet, des icônes apparaissent en regard du 
nom de cet élément. Il existe des icônes pour les masques, les filtres et les comportements. 
Elles permettent de contrôler la visibilité de ces effets dans le Canevas.
Pour désactiver les masques d’une couche ou d’un groupe :
m Cliquez sur l’icône Masques dans la liste de couches de la Timeline. 
Une barre rouge apparaît sur l’icône et l’effet est temporairement désactivé.
Pour désactiver les comportements d’un objet:
m Cliquez sur l’icône Comportements dans la liste de couches de la Timeline.
Une barre rouge apparaît sur l’icône et l’effet est temporairement désactivé.
Pour désactiver les filtres d’une couche ou d’un groupe :
m Cliquez sur l’icône Filtres dans la liste de couches de la Timeline.
Filtre désactivé
Masques
Comportements
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Une barre rouge apparaît sur l’icône et l’effet est temporairement désactivé.
Pour l’ensemble de ces trois commandes, le fait de cliquer à nouveau sur l’icône permet 
de réactiver l’effet.
Options d’affichage de la liste de couches de la Timeline
Comme pour l’onglet Couches, vous pouvez choisir d’afficher ou de masquer les effets 
tels que les masques, les filtres et les comportements. La Timeline vous permet en outre 
d’afficher les images clés. Vous pouvez également choisir d’afficher les pistes audio et, 
si tel est le cas, de masquer les groupes et les couches. L’ensemble de ces options d’affichage est contrôlé par la rangée de boutons située dans l’angle inférieur gauche de 
la Timeline.
Vous pouvez afficher les masques, les comportements et les filtres sous forme de 
couches dans la Timeline, tout comme ils le sont dans l’onglet Couches. L’affichage 
ou le masquage des effets dans la liste ne permet pas de contrôler si les effets 
apparaissent dans le Canevas.
Pour activer/désactiver l’affichage des masques dans la Timeline :
m Cliquez sur le bouton Afficher/Masquer les masques.
Pour activer/désactiver l’affichage des comportements dans la Timeline :
m Cliquez sur le bouton Afficher/Masquer les comportements.
Pour activer/désactiver l’affichage des filtres dans la Timeline :
m Cliquez sur le bouton Afficher/Masquer les filtres.
Lorsque les images clés sont affichées, chaque piste gagne légèrement en hauteur 
et la partie du bas est utilisée pour afficher toute image clé associée à la couche.
Afficher/Masquer l’audio Afficher/Masquer les masques
Afficher/Masquer
les images clés
Afficher/Masquer les comportements
Afficher/Masquer Afficher/Masquer les filtres
les couches
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Pour activer/désactiver l’affichage des images clés dans la Timeline :
m Cliquez sur le bouton Afficher/Masquer les images clés.
Les fichiers audio apparaissent dans une section séparée des autres objets. Vous pouvez 
déplacer la barre de séparation entre les sections audio et vidéo de la Timeline afin 
d’afficher plus ou moins de détails de chaque section.
Pour activer/désactiver l’affichage des fichiers audio :
m Cliquez sur le bouton Afficher/Masquer l’audio situé dans l’angle inférieur gauche 
de l’onglet Timeline.
Pour activer/désactiver l’affichage des couches et des groupes :
m Cliquez sur le bouton Afficher/Masquer les couches situé dans l’angle inférieur gauche 
de l’onglet Timeline.
Remarque : il est impossible de masquer les couches et les groupes, à moins que 
les fichiers audio soient actuellement affichés, le but étant d’éviter d’avoir une Timeline 
complètement vide.
Pour déplacer la barre de séparation entre les pistes audio et vidéo :
m Placez le pointeur au-dessus de la barre de séparation, puis faites-la glisser vers le haut 
ou vers le bas pour étendre ou réduire la section réservée aux pistes.
Vous pouvez régler la hauteur des pistes dans la Timeline, afin de ménager plus 
ou moins d’espace vertical. Vous pouvez également augmenter la taille de la liste 
de couches.
SéparateurChapitre 1 Premiers contacts avec Motion 99
Pour ajuster la hauteur des pistes, procédez de l’une des manières suivantes :
m Placez le pointeur au-dessus de n’importe quelle ligne horizontale, puis faites-la glisser 
vers le haut ou vers le bas afin de diminuer ou d’augmenter la hauteur de toutes 
les pistes.
m Cliquez sur l’un des boutons « Définir la hauteur de ligne de la Timeline » situés en bas 
de l’onglet.
Pour modifier la largeur de la liste de couches de la Timeline :
1 Placez le pointeur sur le bord le plus à droite de la liste de couches de la Timeline.
2 Lorsque le pointeur se transforme en pointeur d’ajustement des colonnes, faites glisser 
vers la gauche ou la droite.
Ajout et suppression de groupes
La Timeline contient des commandes permettant d’ajouter de nouveaux groupes 
et de supprimer certaines couches du projet. 
Pour créer un nouveau groupe dans la liste de couches de la Timeline, procédez 
de l’une des manières suivantes :
m Cliquez sur le bouton Ajouter (+) dans l’angle supérieur gauche de l’onglet.
m Choisissez Objet > Nouveau groupe (ou appuyez sur les touches Maj + Commande + N).
Un nouveau groupe vide est ajouté au haut de la liste.
Vous pouvez également créer de nouveaux groupes en faisant glisser des fichiers vers 
la liste de couches de la Timeline depuis le Navigateur ou la Bibliothèque. Pour en 
savoir plus, voir « Ajout de fichiers à votre projet » à la page 239.
Pour supprimer un objet de la liste de couches de la Timeline, procédez de l’une 
des manières suivantes :
m Sélectionnez l’objet à supprimer, puis cliquez sur le bouton Supprimer (–) dans le coin 
supérieur gauche de l’onglet.
m Appuyez sur la touche Contrôle tout en cliquant sur le fichier que vous voulez 
supprimer, puis choisissez Supprimer dans le menu contextuel.
m Sélectionnez le fichier à supprimer, puis choisissez Édition > Supprimer (ou appuyez 
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L’objet est supprimé. Cette opération supprime également l’objet du Canevas.
Utilisation du champ Image actuelle
À droite des boutons Ajouter (+) et Supprimer (–), la Timeline comporte un champ 
Image actuelle qui peut vous servir à naviguer au sein de votre projet.
Pour placer la tête de lecture sur une nouvelle position, procédez de l’une 
des manières suivantes :
m Cliquez sur le champ de Image actuelle, puis saisissez un numéro d’image.
m Faites glisser le curseur de valeur Sur l’image actuelle vers la gauche ou vers la droite 
pour reculer ou avancer.
Remarque : pour avancer ou reculer plus rapidement, appuyez sur la touche Maj tout 
en faisant glisser le curseur de valeur Sur l’image actuelle.
m La Timeline étant active, tapez le numéro de timecode ou d’image vers lequel vous 
souhaitez déplacer la tête de lecture. Appuyez sur Retour afin de passer à cette image.
Pour avancer d’un nombre spécifique d’images :
m Saisissez le signe plus (+) suivi du nombre d’images dont vous souhaitez avancer.
Pour reculer d’un nombre spécifique d’images :
m Saisissez le signe moins (–) suivi du nombre d’images dont vous souhaitez reculer.
Zone de pistes
La partie principale de la Timeline, à droite de la liste de couches, s’appelle la zone de 
pistes. Chaque objet de votre projet est représenté par une barre de couleur. Différentes 
couleurs permettent de distinguer différents types d’objets. Les comportements et les 
filtres apparaissent par exemple en violet, alors que les couches audio sont vertes. Pour 
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Il existe deux moyens de distinguer les pistes d’un groupe et les pistes individuelles. 
En premier lieu, lorsqu’un objet contenu dans un groupe est sélectionné, une barre 
de groupe étroite apparaît au-dessus des couches de ce groupe. En deuxième lieu, 
lorsque le groupe proprement dit est sélectionné, la piste du groupe affiche un indicateur 
spécial qui identifie le nombre d’objets contenus dans ce groupe. Les couches, 
les caméras et les lumières sont prises en compte dans ce total. En revanche, les effets, 
comme les masques, les comportements et les filtres, ne sont pas comptabilisés.
Vous pouvez réduire une piste de groupe afin que les pistes des objets individuels 
situés dans ce groupe soient temporairement masquées.
Pour réduire ou développer un groupe ou une couche :
m Cliquez sur le triangle d’affichage situé à gauche du nom du groupe ou de la couche 
dans la liste de couches de la Timeline.
La Timeline permet d’effectuer toute une série de tâches de montage telles que 
le déplacement, le Trim et le coulissement. Pour en savoir plus sur le montage dans 
la Timeline, lisez « Modification d’objets dans la Timeline » à la page 375.
Couche réduite Couche développée
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Réglette de la Timeline
Tout en haut de la zone des pistes se trouve la règle qui permet de mesurer les positions 
et les durées des objets de votre projet.
La règle peut contenir des indicateurs qui aident à marquer d’importantes images 
ou sections du projet, telles que la tête de lecture, les indicateurs de plage de lecture 
(appelés également points d’entrée et de sortie) et les marqueurs. La règle peut être 
affichée en images ou en timecode.
Pour modifier le format d’affichage de la réglette :
m Cliquez sur la réglette en maintenant la touche Contrôle enfoncée, puis choisissez 
Afficher les images ou Afficher le timecode dans le menu contextuel.
Remarque : vous pouvez également cliquer sur l’icône Sur l’image actuelle à gauche 
du champ Image actuelle (à gauche des commandes de lecture) ou sur l’icône Durée 
à gauche du champ Durée du projet (à droite des commandes de lecture) pour choisir 
entre l’affichage des images ou du timecode du projet.
La tête de lecture indique l’image visible dans le Canevas. Vous pouvez faire glisser 
la tête de lecture ou la repositionner à l’aide des commandes de lecture décrites dans 
la rubrique « Lecture de votre projet » à la page 65. La tête de lecture de la Timeline 
et celle de la mini-Timeline sont liées. Tout déplacement de l’une d’entre elles entraîne 
automatiquement le déplacement de l’autre.
Les indicateurs de plage de lecture limitent la zone de projet à lire. Pour en savoir plus 
sur le réglage et l’utilisation de la plage de lecture, consultez la rubrique « Définition de 
la plage de lecture » à la page 394.
Il est possible d’ajouter des marqueurs à votre projet afin d’identifier une image 
ou une plage d’images importante. Pour en savoir plus sur la création et l’utilisation 
de marqueurs, consultez la rubrique « Ajout de marqueurs » à la page 398.
Zoom avant sur la Timeline
À mesure que vous vous familiarisez avec l’utilisation de la Timeline, vous éprouverez 
le besoin de passer d’une vue centrée sur un point de montage particulier à une vue 
d’ensemble de votre projet et vice versa. Il existe heureusement différents outils qui 
permettent d’effectuer rapidement un zoom avant ou arrière sur la Timeline.
Point d’entrée Point de sortie
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La partie inférieure de la Timeline contient un curseur de zoom et une case 
de défilement.
Pour effectuer un zoom sur la Timeline à l’aide du curseur de zoom :
m Faites glisser le curseur de zoom vers la gauche pour effectuer un zoom avant et vers 
la droite pour un zoom arrière.
La Timeline est actualisée au fur et à mesure que vous faites glisser la barre.
Pour effectuer un zoom sur la Timeline à l’aide de la case de défilement :
m Cliquez sur la poignée de la case de défilement et faites-la glisser vers l’extérieur pour 
effectuer un zoom arrière et vers le centre pour un zoom avant.
La Timeline est actualisée au fur et à mesure que vous faites glisser la barre.
Vous pouvez également effectuer un zoom automatique sur la Timeline afin d’inclure 
toute la durée de votre projet ou simplement la plage de lecture définie par les indicateurs 
de plage de lecture (points d’entrée et de sortie). 
Pour effectuer un zoom sur la Timeline afin d’afficher la totalité du projet, 
procédez de l’une des manières suivantes :
m Double-cliquez sur le bouton Zoom sur le contrôle du temps, à droite de la règle.
m Choisissez Afficher > Zoom sur le contrôle du temps > Sur le projet.
Remarque : vous devez avoir sélectionné un objet dans la liste de couches de 
la Timeline pour que les options Zoom sur le contrôle du temps soient disponibles 
dans le menu Afficher.
m Cliquez sur la règle en maintenant la touche Contrôle enfoncée, puis choisissez Zoom 
sur le projet dans le menu contextuel.
Pour effectuer un zoom sur la Timeline afin d’adapter la plage de lecture à la fenêtre, 
procédez de l’une des manières suivantes :
m Cliquez sur le bouton Zoom sur le contrôle du temps, à droite de la règle.
m Choisissez Afficher > Zoom sur le contrôle du temps > Sur la plage de lecture.
Remarque : vous devez avoir sélectionné un objet dans la liste de couches de 
la Timeline pour que les options Zoom sur le contrôle du temps soient disponibles 
dans le menu Afficher.
Curseur de zoom
Case de défilement
Poignée
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m Cliquez sur la règle en maintenant la touche Contrôle enfoncée, puis choisissez Zoom 
sur la plage de lecture dans le menu contextuel.
Le bouton Zoom sur le contrôle du temps permet d’alterner les réglages Zoom sur 
la plage de lecture et Zoom sur le projet. Si aucune plage de lecture n’a été définie, 
le choix de la commande Zoom sur la plage de lecture effectue un Zoom sur le projet.
Modification de l’affichage des pistes
Les pistes de Motion peuvent être affichées de plusieurs manières différentes afin 
de répondre à des styles de travail différents. Vous pouvez régler vos pistes afin 
qu’elles soient affichées en fonction du nom uniquement, du nom plus une vignette 
et de la pellicule.
Pour modifier l’affichage des pistes de la Timeline :
1 Choisissez Motion > Préférences (ou appuyez sur les touches Commande + virgule) 
pour ouvrir les préférences Motion.
2 Cliquez sur l’icône Apparence pour ouvrir la fenêtre du même nom.
3 Dans la section réservée à la Timeline, choisissez une option dans le menu local Affichage 
de la barre de temps :
Â Nom : affiche uniquement le nom de l’objet sur la piste.
Â Nom plus vignette : affiche le nom de l’objet et une seule vignette sur la piste.
Â Pellicule : affiche les images de l’objet sur toute la piste.
Quel que soit le réglage choisi pour l’affichage de la barre de temps, seuls les noms 
des caméras, lumières, comportements et filtres sont affichés sur les pistes.
Remarque : lorsque Affichage de la barre de temps est réglé sur Pellicule, le temps 
de traitement est augmenté.
Nom
Nom plus vignette (par défaut)
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Éditeur d’images clés
L’Éditeur d’images clés permet de visualiser et de modifier les attributs individuels des 
filtres, comportements et autres effets dans le temps. Chaque paramètre peut être affiché sous la forme d’une courbe décrivant la manière dont sa valeur évolue dans le 
temps. Vous pouvez manipuler les points situés sur cette courbe (appelés images clés) 
afin de créer toute une série de puissants effets. Pour en savoir plus sur l’utilisation de 
l’Éditeur d’images clés, voir le chapitre 6, « Images et clés et courbes », à la page 547. 
Pour afficher l’Éditeur d’images clés, procédez de l’une des manières suivantes :
m Faites glisser la barre de séparation située en bas du Canevas, puis cliquez sur l’onglet 
Éditeur d’images clés en haut de la fenêtre.
m Cliquez sur l’icône Contrôle du temps dans l’angle supérieur droit du Canevas, 
puis cliquez sur l’onglet Éditeur d’images clés en haut de la fenêtre.
m Choisissez Fenêtre > Éditeur d’images clés (ou appuyez sur les touches 
Commande + 8).
m Appuyez sur F6, puis cliquez sur l’onglet Éditeur d’images clés en haut de la fenêtre.
m Choisissez Fenêtre > Présentations > Cinéma (ou appuyez sur les touches 
Contrôle + Option + U), puis cliquez sur l’onglet Éditeur d’images clés en haut 
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m Si la fenêtre Contrôle du temps est déjà affichée, cliquez sur l’onglet Éditeur d’images 
clés en haut de la fenêtre.
Liste des paramètres de l’Éditeur d’images clés
La partie gauche de l’Éditeur d’images clés contient une liste de paramètres. Vous pouvez 
choisir les paramètres à afficher dans la liste et définir des fonctions d’animation 
par images clés via le menu Animation. Vous pouvez également créer des ensembles 
personnalisés de paramètres. Cela vous permet de vous concentrer sur certains 
paramètres à la fois. Pour en savoir plus sur la création et l’affichage de ces ensembles 
de paramètres, voir « Ensembles de paramètres personnalisés » à la page 581.
Menu local Afficher
Utilisez le menu local Afficher pour sélectionner ce qui s’affiche dans l’Éditeur 
d’images clés. Les options Afficher sont les suivantes :
Tout : cette option affiche tous les paramètres de l’objet actuellement sélectionné 
dans la liste, que ces paramètres soient animés ou non.
Notions élémentaires sur les images clés
Pour animer un objet, il vous suffit de créer aux moins deux images clés pour l’un 
de ses paramètres, comme Opacité, à différents points dans le temps d’un projet. 
Une image clé est en fait un point dans le temps qui enregistre la moindre modification relative à la valeur d’un paramètre. Par exemple, pour créer une animation dans 
laquelle un objet est totalement transparent au niveau de l’image 1, puis devient 
complètement opaque à l’image 120, créez deux images clés : une première image 
clé Opacité réglée sur une valeur de 0 % sur l’image 1 et une deuxième réglée sur 
une valeur de 100 % sur l’image 120. L’image subit alors un fondu entrant de 0 à 
100 % sur les 120 images. La transition lisse de ce fondu entre les deux valeurs animées par des images clés s’appelle l’interpolation.
Toutes les images clés liées à un paramètre particulier (Opacité ou Rotation, par exemple) sont positionnées sur une ligne dans le temps. Les différentes valeurs des images 
clés changent la forme de cette ligne, créant ce qu’il convient d’appeler une courbe 
d’animation. Il est possible de modifier le type de cette courbe d’une image clé 
à la suivante (l’interpolation) dans le but d’obtenir des effets d’animation différents. 
À titre d’exemple, les images clés réglées sur Bézier génèrent des transitions lisses 
entre les valeurs. En revanche, les images clés réglées sur Linéaire créent des lignes 
droites, accentuant les changements de valeurs. L’Éditeur d’images clés, situé dans 
la fenêtre Contrôle du temps, vous permet de modifier les images clés et leurs courbes d’animation. Pour en savoir plus, voir « Images et clés et courbes » à la page 547. Chapitre 1 Premiers contacts avec Motion 107
Animé : cette option affiche uniquement les paramètres animés et les courbes de 
l’objet actuellement sélectionné, ce qui inclut les courbes d’animation créées à l’aide 
d’images clés, mais aussi de comportements. Il s’agit du réglage par défaut. Si l’Éditeur 
d’images clés est activé, vous pouvez également appuyer sur la touche U pour choisir 
Activé dans le menu local Afficher.
Lorsque l’objet sélectionné n’est pas animé, l’Éditeur d’images clés n’affiche rien.
Modifié : cette option affiche uniquement les courbes modifiées de l’objet actuellement 
sélectionné, ce qui inclut les modifications qui ne sont pas animées. Par exemple, si vous 
modifiez la couleur d’une forme (sans pour autant animer ce changement de couleur), 
le paramètre apparaît dans la liste Modifié, car la couleur a été changée par rapport à 
la couleur par défaut. Cette liste répertorie également les paramètres animés. Si l’Éditeur 
d’images clés est activé, vous pouvez également appuyer sur la touche Y pour choisir 
Modifié dans le menu local Afficher.
Actif : cette option affiche uniquement les paramètres en cours de modification. Si vous 
la sélectionnez, rien n’apparaît dans l’Éditeur d’images clés, sauf si vous êtes effectivement 
en train de modifier un objet (dans le Canevas, l’Inspecteur ou la palette). Par exemple, 
lorsque l’option Actif est sélectionnée et que vous déplacez un objet dans le Canevas, 
les paramètres Position X et Y et les courbes correspondantes sont affichés.
Position : affiche uniquement les paramètres Position de l’objet sélectionné. Si l’Éditeur 
d’images clés est activé, vous pouvez également appuyer sur la touche P pour choisir 
Position dans le menu local Afficher.
Rotation : affiche uniquement les paramètres Rotation de l’objet sélectionné. Si l’Éditeur 
d’images clés est activé, vous pouvez également appuyer sur la touche R pour choisir 
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Échelle : affiche uniquement les paramètres Échelle de l’objet sélectionné. Si l’Éditeur 
d’images clés est activé, vous pouvez également appuyer sur la touche S pour choisir 
Échelle dans le menu local Afficher.
Déformation : affiche uniquement les paramètres Déformation de l’objet sélectionné. 
Si l’Éditeur d’images clés est activé, vous pouvez également appuyer sur la touche H 
pour choisir Déformation dans le menu local Afficher.
Point d’ancrage : affiche uniquement les paramètres Point d’ancrage de l’objet sélectionné. Si l’Éditeur d’images clés est activé, vous pouvez également appuyer 
sur la touche A pour choisir Point d’ancrage dans le menu local Afficher.
Opacité : affiche uniquement les paramètres Opacité de l’objet sélectionné. Si l’Éditeur 
d’images clés est activé, vous pouvez également appuyer sur la touche O pour choisir 
Opacité dans le menu local Afficher.
Nouvel ensemble de courbes : vous permet de créer un ensemble personnalisé 
de courbes.
Gérer les ensembles de courbes : vous permet de gérer (supprimer, dupliquer, etc.) 
vos ensembles personnalisés de courbes.
Remarque : pour en savoir plus sur l’utilisation des ensembles de courbes, 
voir « Ensembles de paramètres personnalisés » à la page 581.
Organisation de la liste des paramètres
La liste des paramètres est divisée en quatre colonnes.
Activé (sans titre) : cette colonne contient des cases à cocher qui permettent d’activer 
ou de désactiver l’affichage des paramètres correspondants dans le graphique d’images 
clés. L’activation de la case en regard d’un objet active ou désactive uniquement 
l’affichage des paramètres de cet objet (son animation n’est en aucun cas affectée). 
Nom (sans titre) : affiche le nom de l’objet sélectionné et ses paramètres.
Valeur (sans titre) : affiche la valeur de la position actuelle de la tête de lecture pour 
ce paramètre. Vous pouvez faire glisser dans le champ valeur afin de définir de nouvelles 
valeurs d’image clé, ou double-cliquer dans le champ et saisir une nouvelle valeur. 
Pour en savoir plus, voir « Modification d’images clés » à la page 586.
Menu Animation (sans titre) : la dernière colonne contient un menu local qui permet 
de contrôler l’animation et les attributs d’animation par images clés de ce paramètre. 
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Â Activer/Désactiver l’animation : cette commande demeure indisponible jusqu’à 
ce qu’une animation par images clés soit appliquée au canal soit via le bouton 
Enregistrer, soit en ajoutant directement une image clé. Dès que le canal est animé, 
le nom de la commande de menu devient automatiquement « Désactiver l’animation ». 
Toute activation ultérieure de cette commande a pour effet de masquer les images 
clés que vous avez définies, en rétablissant la valeur par défaut du paramètre. Toutefois, 
les images clés ne sont pas supprimées. Si vous sélectionnez Activer l’animation à 
nouveau, le canal est restauré sur son état animé avec des images clés le plus récent
Â Réinitialiser le paramètre : supprime toutes les images clés et les réglages pour 
ce paramètre. La valeur par défaut du paramètre est rétablie.
Â Ajouter une image clé : ajoute une image clé à l’image actuelle. Si la tête de lecture 
est placée sur une image à laquelle une image clé a déjà été ajoutée, cet élément de 
menu n’est pas disponible.
Remarque : vous pouvez également cliquer sur le menu Animation tout en maintenant la touche Option enfoncée pour ajouter une image clé. Une image clé est alors 
automatiquement ajoutée au dernier paramètre modifié de l’objet (quel que soit 
l’état du bouton Enregistrer) à la position actuelle de la tête de lecture.
Â Supprimer l’image clé : supprime l’image clé actuelle. La commande Supprimer 
l’image clé n’est disponible que si la tête de lecture est placée sur une image 
contenant une image clé.
Remarque : pour supprimer une image clé, vous pouvez également cliquer dessus 
tout en maintenant la touche Contrôle enfoncée, puis choisir Supprimer dans 
le menu contextuel, voire la sélectionner, puis appuyer sur Suppr.
Â Image clé précédente : place la tête de lecture sur l’image clé précédente de ce 
paramètre. La commande Image clé précédente n’est disponible que si une image 
clé existe plus tôt dans le projet.
Remarque : vous pouvez également appuyer sur les touches Option + K pour revenir 
à l’image clé précédente.
Â Image clé suivante : place la tête de lecture sur l’image clé suivante de ce paramètre. 
La commande Image clé suivante n’est disponible que si une image clé existe plus 
loin dans le projet.
Remarque : vous pouvez également appuyer sur les touches Maj + K pour passer 
à l’image clé suivante.
Â Interpolation : définit le type de courbe du paramètre. Pour des exemples 
des différentes méthodes d’interpolation, voir le tableau « Modification des courbes » 
à la page 595.
Â Avant la première image clé : définit l’animation avant la première image clé 
d’un paramètre. Il s’agit d’une extrapolation.
Â Après la dernière image clé : définit l’animation après la dernière image clé 
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Remarque : pour des exemples des différentes méthodes d’extrapolation, 
voir « Extrapolation » à la page 600.
Â Verrouiller/Déverrouiller le paramètre : verrouille ce paramètre pour empêcher 
les modifications. Lorsqu’un paramètre est verrouillé, ni les images clés, ni les courbes 
ne peuvent être ajustées.
Â Réduire les images clés : applique un algorithme de suppression aux images clés 
du paramètre sélectionné. Cela permet de réduire le nombre d’images clés dans 
un paramètre, tout en essayant de maintenir une forme de courbe similaire. 
Pour en savoir plus sur la suppression d’images clés, voir « Suppression d’images clés » 
à la page 610.
Â Définir sur instantané de courbe : si la case « Prendre/Afficher instantané de 
courbe » est cochée, cette option inverse toutes les modifications apportées aux 
images clés de la courbe actuellement sélectionnée et revient à l’instantané le plus 
récent. Pour en savoir plus, voir « Instantanés de courbes » à la page 586.
États du menu Animation
Le menu Animation affiche une icône différente en fonction de l’état actuel du paramètre 
pour l’objet sélectionné. Le tableau suivant montre les icônes du menu Animation.
Champ Sur l’image actuelle
Le champ « Sur l’image actuelle » est affiché entre le menu local Afficher et les outils 
de modification des images clés.
Pour en savoir plus, voir « Champs Timecode et Image actuelle » à la page 71.
Icône Nom Description
Aucune image clé Aucune image clé n’est associée au paramètre.
Images clés activées Les images clés sont activées pour ce paramètre, mais 
la tête de lecture n’est pas placée sur une image clé.
Image clé actuelle La tête de lecture est actuellement placée sur une image 
clé pour ce paramètre.
Comportement appliqué Ce paramètre est contrôlé par un comportement, 
et non par une image clé. Si un comportement est 
appliqué à une couche ou un groupe, son nom apparaît 
dans le menu Animation.
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Outils de modification des images clés
L’Éditeur d’images clés met à votre disposition trois outils pour vous aider à modifier 
des images clés et des courbes. Pour en savoir plus sur l’utilisation de ces outils, voir 
« Modification d’images clés » à la page 586.
Édition : sélectionne et modifie des images clés.
Esquisse : dessine des courbes avec des images clés. Pour ce faire, vous devez disposer 
d’un paramètre actif (sa case est donc cochée) et le sélectionner dans la liste.
Cadre : fait glisser une zone de sélection pour entourer et manipuler les images clés.
Boutons disponibles dans l’Éditeur d’images clés
Dans son angle inférieur gauche, l’Éditeur d’images clés comporte cinq boutons qui vous 
offrent des commandes supplémentaires : Magnétisme, Afficher la forme d’onde audio, 
Ajuster les courbes, Effacer la liste de courbes et Prendre/Afficher instantané de courbe.
Magnétisme : lorsque cette option est activée, les images clés s’alignent par 
magnétisme sur d’autres images clés, des marqueurs, des points de la grille 
et d’autres éléments susceptibles de provoquer ce magnétisme.
Afficher la forme d’onde audio : active l’affichage des formes d’onde audio de l’objet 
sélectionné.
Cadre
Esquisse
Édition
Effacer la liste de courbes
Afficher la forme d’onde audio
Ajuster les courbes
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Si l’option « Afficher la forme d’onde audio » est activée et que votre projet comporte 
au moins un fichier audio, un menu local situé en bas de l’Éditeur d’images clés vous 
permet de visualiser la forme d’onde de la piste Master ou de toute piste audio de 
votre projet.
Ajuster les courbes visibles à la fenêtre : redimensionne automatiquement le graphique 
à la verticale et à l’horizontale (dans le temps), afin qu’il inclut toutes les images clés 
de vos paramètres actifs.
Effacer la liste de courbes : vide la liste des paramètres. Cette commande n’est disponible 
que pour les ensembles de courbes personnalisés.
Prendre/Afficher instantané de courbe : si cette option est activée, dès lors que 
vous déplacez des images clés dans l’Éditeur d’images clés, la courbe d’origine apparaît 
dans une couleur plus claire (telle qu’elle était au moment où vous avez pris l’instantané). 
Cet instantané de courbe reste disponible aussi longtemps que vous modifiez l’ensemble 
actuel de courbes l’Éditeur d’images clés.
Ajustement vertical automatique pour afficher entièrement les courbes : utilisez 
cette option pour étirer le graphique verticalement, afin qu’il affiche l’intégralité des 
courbes.
Pour activer/désactiver le mode de mise à l’échelle automatique :
m Cliquez sur le bouton « Ajustement vertical automatique pour afficher entièrement 
les courbes » situé juste sous le bord droit de la règle.
Cliquez ici pour afficher une liste de toutes 
les pistes audio disponibles dans le projet. 
L’Éditeur d’images clés affiche alors la forme 
d’onde de la piste sélectionnée dans cette liste.
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Graphique d’images clés
Le reste de l’Éditeur contient le graphique d’images clés. Cette zone affiche toutes 
les courbes et images clés pour les paramètres sélectionnés. Les divers paramètres 
sont représentés par des couleurs différentes. Les images clés apparaissent sous la 
forme de losanges et les courbes sont représentées par des lignes continues. Les zones 
qui précèdent la première image clé et celles qui suivent la dernière image clé sont 
représentées par des lignes pointillées. Les paramètres et les images clés sélectionnés 
sont affichés en blanc.
Vous pouvez manipuler directement les images clés en les faisant glisser dans 
le graphique. Un déplacement vers la droite ou la gauche des images clés permet 
de changer leur position dans le temps, tandis qu’un déplacement vers le haut ou 
le bas permet de modifier leur valeur. Vous pouvez également double-cliquer sur 
une image clé, saisir un nombre dans le champ déroulant de valeur, puis appuyer 
sur Retour afin de modifier sa valeur.
Tout en maintenant la touche Contrôle enfoncée, cliquez sur une image clé pour 
accéder aux options du menu contextuel, ainsi qu’au sous-menu Interpolation qui 
vous permet de changer le type des courbes. Pour en savoir plus sur la manipulation 
des images clés et des courbes dans le graphique, voir « Modification d’images clés » 
à la page 586 et « Modification des courbes » à la page 595.
Règle
En haut du graphique d’images clés figure une règle qui fournit un repère visuel concernant la position et la durée des images clés et des courbes. Cette règle est identique à la 
réglette de la Timeline. Pour en savoir plus sur l’utilisation de cette règle, voir « Réglette 
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Zoom sur l’Éditeur d’images clés
À mesure que vous vous familiarisez avec l’utilisation de l’Éditeur d’images clés, vous 
éprouverez le besoin de passer d’une vue centrée sur une image clé ou une courbe 
particulière à une vue d’ensemble de votre projet et vice versa. Il existe heureusement 
différents outils qui permettent d’effectuer rapidement un zoom avant ou arrière sur 
l’Éditeur d’images clés.
La partie inférieure de l’Éditeur d’images clés contient un curseur de zoom et une case 
de défilement.
Pour effectuer un zoom sur l’Éditeur d’images clés à l’aide du curseur de zoom :
m Faites glisser le curseur de zoom vers la gauche pour effectuer un zoom avant ou vers 
la droite pour un zoom arrière.
L’Éditeur d’images clés est actualisé au fur et à mesure que vous faites glisser le curseur.
Pour effectuer un zoom sur l’Éditeur d’images clés à l’aide de la case de défilement:
m Faites glisser la poignée de la case de défilement vers l’extérieur pour effectuer 
un zoom arrière et vers le centre pour un zoom avant.
L’Éditeur d’images clés est actualisé au fur et à mesure que vous faites glisser la case.
Éditeur audio
L’Éditeur audio vous offre une vue de vos éléments audio au fil du temps. Vous pouvez 
visualiser et modifier les informations des réglages de niveau et de balance des fichiers 
audio de votre projet. Vous pouvez également visualiser les formes d’onde audio de 
vos couches. L’Éditeur audio n’est, par de nombreux aspects, rien d’autre qu’un Éditeur 
d’images clés spécialisé réservé à l’audio. Pour en savoir plus sur l’utilisation de l’Éditeur 
audio, voir « Utilisation de données audio » à la page 1203.
Curseur de zoom
Case de défilement
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Pour afficher l’Éditeur audio, procédez de l’une des manières suivantes :
m Choisissez Fenêtre > Éditeur audio (ou appuyez sur les touches Commande + 9).
m Faites glisser la barre de séparation située en bas du Canevas, puis cliquez sur l’onglet 
Éditeur audio en haut de la fenêtre.
m Si la fenêtre Contrôle du temps est déjà affichée, cliquez sur l’onglet Éditeur audio 
en haut de la fenêtre.
m Cliquez sur l’icône Contrôle du temps dans l’angle supérieur droit du Canevas, 
puis cliquez sur l’onglet Éditeur audio en haut de la fenêtre.
m Appuyez sur F6, puis cliquez sur l’onglet Éditeur audio en haut de la fenêtre.
Choisissez Fenêtre > Présentations > Cinéma (ou appuyez sur les touches 
Contrôle + Option + U), puis cliquez sur l’onglet Éditeur audio en haut de la fenêtre.
Commandes de l’Éditeur audio
La partie gauche de l’Éditeur audio contient quatre rangées de commandes, chacune 
dédiée à un aspect particulier de la piste audio actuellement affichée. La première concerne les commandes de lecture, la deuxième contrôle les points d’entrée et de sortie 
de la piste audio, la troisième contrôle le niveau de la piste sélectionnée et la quatrième 
contrôle ses réglages de balance.
Commandes de lecture
Commandes de la plage de lecture
Commandes de niveau
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Commandes de lecture de l’Éditeur audio
Les commandes de lecture de l’Éditeur audio ne contrôlent pas la lecture dans 
le Canevas. Vous pouvez ainsi écouter les composants audio de votre projet sans 
être distrait (ou ralenti) par les composants visuels.
Vous disposez de quatre commandes de lecture :
Aller au début : déplace la tête de lecture au début du plan audio ou du morceau 
audio marqué (si le bouton « Utiliser le morceau audio marqué » est activé).
Lecture/Pause : lance et met en pause la lecture dans l’Éditeur audio.
Utiliser le morceau audio marqué : limite la lecture à la plage de lecture définie 
(les points d’entrée et de sortie) pour la piste audio sélectionnée. Pour en savoir plus, 
voir « Commandes de la plage de lecture de l’Éditeur audio » à la page 116.
Champ Sur l’image actuelle : indique la position actuelle de la tête de lecture 
dans l’Éditeur audio. Vous pouvez également utiliser ce champ pour modifier 
l’image actuelle.
Pour modifier la position de la tête de lecture, procédez de l’une des manières suivantes :
m Faites glisser le centre du champ Sur l’image actuelle. Un glissement vers la droite 
permet d’avancer et un glissement vers la gauche permet de revenir en arrière.
m Cliquez sur la flèche vers la droite ou la gauche située de chaque côté du champ 
Sur l’image actuelle, pour avancer ou reculer d’une image.
m Cliquez sur le champ Sur l’image actuelle et tapez une nouvelle valeur.
Commandes de la plage de lecture de l’Éditeur audio
La deuxième rangée fournit deux commandes qui servent à définir des points d’entrée 
et de sortie du fichier audio. La modification du point d’entrée ou de sortie d’un fichier 
dans l’Éditeur audio est reflétée dans la Timeline. La zone de la piste située entre les 
points d’entrée et de sortie est la région utilisée lorsque l’option « Utiliser le morceau 
audio marqué » est activée dans les commandes de lecture.
Remarque : il est impossible de modifier les points d’entrée et de sortie de la piste Master.
Mag
Lecture/Pause Image actuelle
Utiliser le morceau audio marqué
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Pour modifier l’heure de début d’une piste audio à l’aide du curseur Entrée, procédez 
de l’une des manières suivantes :
m Faites glisser le centre du curseur Entrée. Un glissement vers la droite permet d’avancer 
l’audio, alors qu’un glissement vers la gauche le recule.
m Cliquez sur les flèches situées de chaque côté du champ Entrée, pour avancer 
ou reculer d’une image.
m Cliquez dans le champ, puis saisissez un nouveau nombre.
Pour modifier l’heure de fin d’une couche, procédez de l’une des manières 
suivantes :
m Faites glisser le centre du curseur Sortie. Un glissement vers la droite permet d’avancer 
l’audio, alors qu’un glissement vers la gauche le recule.
m Cliquez sur la flèche vers la droite ou la gauche située de chaque côté du champ Sortie, 
pour avancer ou reculer d’une image.
m Cliquez dans le champ, puis saisissez un nouveau nombre.
Vous pouvez également modifier les heures de début et de fin à l’aide de la barre de 
la piste audio.
Pour modifier les heures de début et de fin à l’aide de la barre de la piste audio :
m Sélectionnez la piste dans l’onglet Audio, puis faites glisser l’une des extrémités de 
la barre verte de la piste audio (située au-dessus de la forme d’onde dans l’Éditeur audio).
Remarque : vous ne pouvez pas marquer des morceaux sur la piste audio Master.
Commande de niveau
La troisième rangée contient des commandes qui servent à ajuster et à animer avec 
des images clés le niveau de la piste audio sélectionnée.
Case d’activation : située à gauche de la rangée, cette case à cocher active ou désactive 
l’affichage de la courbe d’animation du niveau. Elle ne désactive pas les réglages 
de niveau existants, ni ne vous empêche d’en créer d’autres.
Niveau : curseur et champ servant à contrôler le niveau (volume) de la piste. Si la tête 
de lecture est positionnée sur une image clé, le curseur contrôle le niveau de cette 
image clé. Si la tête de lecture ne se trouve pas sur une image clé, le curseur contrôle 
toute la courbe.
Commande Balance
La quatrième rangée contient les commandes qui permettent d’ajuster et d’animer 
avec des images clés la balance de la piste sélectionnée (balance gauche-droite). 
Case d’activation : située à gauche de la rangée, cette case à cocher active ou désactive 
l’affichage de la courbe d’animation de la balance. Elle ne désactive pas les réglages 
de balance existants, ni ne vous empêche d’en créer d’autres.118 Chapitre 1 Premiers contacts avec Motion
Balance : curseur et champ servant à contrôler la balance gauche-droite de la piste. 
Si la tête de lecture est positionnée sur une image clé, le curseur contrôle la balance 
de cette image clé. Si la tête de lecture ne se trouve pas sur une image clé, le curseur 
contrôle toute la courbe de balance. Les valeurs négatives déplacent la balance vers 
la gauche, tandis que les valeurs positives la déplacent vers la droite. Une valeur égale 
à zéro indique une balance identique à gauche et à droite. Optez pour le curseur 
de valeur si vous souhaitez d’affiner votre réglage.
Menu Animation: affiché à droite des curseurs Niveau et Balance, ce menu est semblable 
au menu Animation présent dans l’Éditeur d’images clés. Le menu est représenté 
par différentes icônes en fonction de l’état du paramètre. Pour consulter un tableau 
décrivant ces différentes icônes, voir « États du menu Animation » à la page 110. 
Les commandes du menu Animation sont répertoriées ci-après :
Â Activer/Désactiver l’animation : active et désactive l’animation par images clés pour 
ce paramètre. Une fois que des images clés ont été ajoutées, le choix de la commande 
Désactiver l’animation ne supprime pas les images clés mais ne fait que masquer 
généralement leurs effets.
Â Réinitialiser le paramètre : supprime les images clés éventuelles et rétablit 
les valeurs par défaut du paramètre.
Â Ajouter une image clé : ajoute une nouvelle image clé à l’emplacement de la tête 
de lecture.
Remarque : vous pouvez également cliquer sur le menu Animation tout en 
maintenant la touche Option enfoncée pour ajouter une image clé.
Â Supprimer l’image clé : supprime l’image clé située à l’emplacement actuel de 
la tête de lecture.
Â Image clé précédente : place la tête de lecture sur la première image clé située 
à gauche de l’emplacement actuel de la tête de lecture.
Â Image clé suivante : place la tête de lecture sur la première image clé située à droite 
de l’emplacement actuel de la tête de lecture.
Â Afficher dans l’Éditeur d’images clés : affiche les paramètres audio dans l’Éditeur 
d’images clés et place cet onglet au premier plan.Chapitre 1 Premiers contacts avec Motion 119
Indicateurs de niveau
Les indicateurs de niveau audio sont situés dans la partie droite des commandes 
de l’Éditeur audio. Ils comportent deux barres verticales qui indiquent le niveau 
à l’emplacement actuel de la tête de lecture. La barre de gauche indique les niveaux 
du canal audio de gauche et la barre de droite indique les niveaux du canal audio 
de droite. Ces indicateurs changent au fur et à mesure de la lecture pour refléter 
l’évolution des niveaux audio.
Les indicateurs de pics apparaissent au-dessus des autres compteurs. Ces petits témoins 
lumineux deviennent rouges dès que le volume dépasse les niveaux acceptables 
(niveaux de saturation). Ils demeurent rouges pendant quelques instants après 
l’apparition des pics.
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Graphique d’images clés de l’Éditeur audio
Le reste de la fenêtre contient le graphique d’images clés. Cette zone contient les courbes 
et les images clés relatives au niveau et à la balance de la piste sélectionnée. Les images 
clés apparaissent sous la forme de losanges et les courbes sont représentées par des 
lignes continues. Les zones qui précèdent la première image clé et celles qui suivent 
la dernière image clé sont représentées par des lignes pointillées. La forme d’onde 
de la piste sélectionnée est affichée à l’arrière des courbes.
Une barre verte située au sommet du graphique indique la durée du fichier audio. 
Cette barre rétrécit ou s’allonge pour refléter la nouvelle durée, au fur et à mesure 
que vous modifiez les points d’entrée et de sortie du fichier.
Tout comme dans l’Éditeur d’images clés, vous pouvez manipuler les images clés en 
les faisant glisser dans le graphique. Un déplacement vers la droite ou la gauche permet 
de changer leur position dans le temps, alors qu’un déplacement vers le haut ou le bas 
modifie leur valeur. Comme les images clés audio fonctionnent exactement de la même 
façon que les images clés des autres paramètres, pour en savoir plus sur leur utilisation, 
voir « Modification d’images clés » à la page 586 et « Modification des courbes » à la 
page 595.
Règle
En haut du graphique d’images clés de l’Éditeur audio figure une règle qui fournit 
un repère visuel concernant la position et la durée des images clés et des courbes de 
niveau et de balance. La règle de l’Éditeur audio affiche une durée différente de celle 
affichée dans les règles de la Timeline et de l’Éditeur d’images clés. En effet, cette règle 
affiche la durée du fichier audio sélectionné, au lieu de celle de l’ensemble du projet.
La règle peut contenir des indicateurs qui aident à marquer d’importantes images 
ou sections du projet, telles que la tête de lecture, les indicateurs de plage de lecture 
(appelés également points d’entrée et de sortie) et les marqueurs. La règle peut être 
affichée en images ou en timecode.
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Pour modifier le format d’affichage de la règle :
m Cliquez sur la règle en maintenant la touche Contrôle enfoncée, puis choisissez Afficher 
les images ou Afficher le timecode dans le menu contextuel.
Il est possible d’ajouter des marqueurs à votre projet afin d’identifier une image 
ou une plage d’images importante. Pour en savoir plus sur la création et l’utilisation 
de marqueurs, voir « Ajout de marqueurs » à la page 398.
Remarque : la tête de lecture de l’Éditeur audio n’est pas la même que celle de la Timeline et du Canevas. Elle indique la position temporelle actuelle au sein de la piste audio 
sélectionnée plutôt qu’au sein du projet entier.
Zoom dans l’Éditeur audio
Pour effectuer un zoom avant ou arrière dans l’Éditeur audio, procédez comme 
à l’accoutumée dans la Timeline ou l’Éditeur d’images clés. 
La partie inférieure de l’Éditeur audio contient un curseur de zoom et une case 
de défilement.
Pour effectuer un zoom dans l’Éditeur audio à l’aide du curseur de zoom :
m Faites glisser le curseur de zoom vers la gauche pour effectuer un zoom avant et vers 
la droite pour un zoom arrière.
L’Éditeur audio est actualisé au fur et à mesure que vous faites glisser le curseur.
Pour effectuer un zoom dans l’Éditeur audio à l’aide de la case de défilement:
m Cliquez sur la poignée de la case de défilement et faites-la glisser vers l’extérieur 
pour effectuer un zoom arrière et vers le centre pour un zoom avant.
L’Éditeur audio est actualisé au fur et à mesure que vous faites glisser la case.
Défilement audio
Vous pouvez choisir d’entendre le son lorsque vous faites glisser la tête de lecture 
à travers la règle dans l’Éditeur audio. Ce processus est appelé défilement audio. 
Pour activer ou désactiver le défilement audio, cliquez sur le bouton situé dans l’angle 
inférieur droit de l’Éditeur audio.
Fenêtre Utilitaire
La fenêtre Utilitaire vous permet de localiser, organiser et modifier les médias, les effets 
et les paramètres associés à votre projet. Vous pouvez notamment y effectuer les opé-
rations suivantes : trier les médias sur votre disque et naviguer parmi tous les effets, 
préréglages et autres contenus, ainsi que visualiser et manipuler tous les paramètres 
qui contrôlent le comportement de vos objets et de vos effets.122 Chapitre 1 Premiers contacts avec Motion
La fenêtre Utilitaire comprend trois onglets : Navigateur, Bibliothèque et Inspecteur. 
Dans le mode de présentation par défaut, ces trois onglets se trouvent dans une fenêtre 
Utilitaire située dans la partie gauche du Canevas. Si vous choisissez le mode de présentation Cinéma, deux fenêtres Utilitaire sont affichées : l’une à gauche du Canevas avec 
le Navigateur et la Bibliothèque, et l’autre à droite du Canevas, contenant l’Inspecteur.
Navigateur
Le Navigateur affiche tous les fichiers contenus sur votre ordinateur. La navigation via 
le Navigateur est similaire à la navigation dans une fenêtre du Finder. Vous pouvez faire 
glisser directement des éléments du Navigateur dans votre projet.
Zone de Preview
La partie supérieure du Navigateur contient une zone de Preview de la couche sélectionnée. Cette zone comporte aussi bien un aperçu visuel, accompagné d’un bouton 
de lecture pour afficher les diverses images de la séquence animée, que des informations 
sur le fichier : son nom, son type, sa taille et sa fréquence d’images. Cette zone de Preview 
comporte également un bouton permettant de désactiver l’audio. Cliquez dessus 
pour couper le son associé à un fichier sélectionné dans le Navigateur.
Remarque : lorsqu’ils sont affichés dans la zone de Preview, les fichiers audio présentent 
un texte descriptif, mais aucun aperçu visuel.
Pour prévisualiser un fichier situé sur votre disque :
m Sélectionnez le fichier dans le Navigateur.
La prévisualisation commence.
Remarque : si vous ne souhaitez pas lire automatiquement des éléments dans la zone 
de Preview lorsque vous cliquez dessus (dans le Navigateur ou la Bibliothèque), désactivez la case « Lire automatiquement les éléments en un seul clic » dans la fenêtre 
Générales des préférences Motion.
Pour importer un fichier affiché dans la zone de Preview :
1 Sélectionnez le fichier dans le Navigateur.
2 Cliquez sur le bouton Importer dans la zone de Preview. 
Le fichier est ajouté au projet (dans le Canevas, l’onglet Couches, la liste de couches 
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Remarque : pour obtenir une prévisualisation plus grande, vous pouvez double-cliquer 
sur n’importe quel fichier figurant dans le Navigateur. La fenêtre Visualiseur apparaît 
alors. Vous pouvez y prévisualiser le fichier à sa taille d’origine. Vous pouvez également 
cliquer sur un fichier tout en maintenant la touche Contrôle enfoncée, puis choisir 
« Ouvrir dans QuickTime Player » dans le menu contextuel.
Barre latérale
La section centrale du Navigateur contient des commandes de navigation ainsi qu’une 
liste des serveurs, disques durs et dossiers disponibles sur votre ordinateur.
Cliquez sur un disque ou un dossier dans la barre latérale pour afficher le contenu 
de ces éléments dans la pile de fichiers située en dessous. Plusieurs commandes situées 
au-dessus de la liste des icônes de disque et de dossier dans la barre latérale permettent 
de naviguer parmi les éléments affichés dans la fenêtre et de les trier.
Boutons Précédent et Suivant: ces boutons permettent de naviguer à travers les dossiers 
récents. Ils fonctionnent de la même manière que les boutons Suivant et Précédent 
du Finder.
Menu local Chemin: affiche la hiérarchie du système de fichiers (imbrication des dossiers) 
du dossier ouvert.
Boutons Présentation par icônes et Présentation par liste : permet de contrôler 
le mode de présentation de la pile de fichiers. Cliquez sur le bouton de gauche 
pour sélectionner le mode de présentation par icône. Cliquez sur le bouton de droite 
pour sélectionner le mode de présentation par liste.
Champ de recherche : filtre le contenu de la pile de fichiers, afin de n’inclure que 
les fichiers dont les noms contiennent le texte saisi dans le champ de recherche.
Remarque : les dossiers ne sont pas affectés par le filtrage.
Boutons Suivant/Précédent Boutons Affichage
Menu local Chemin
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Pour effacer le champ de recherche :
m Cliquez sur le bouton Effacer situé à droite du champ de recherche.
Pile de fichiers du Navigateur
La section inférieure du Navigateur affiche le contenu du dossier sélectionné dans 
la barre latérale ou le contenu d’un sous-dossier.
Dans le Navigateur, vous pouvez cliquer sur un fichier tout en maintenant la touche 
Contrôle enfoncée pour afficher un menu contextuel. Pour la plupart des éléments, 
ce menu propose les options suivantes :
Ouvrir dans le Visualiseur: cette option ouvre le fichier dans une fenêtre du Visualiseur.
Ouvrir dans QuickTime Player : cette option ouvre le fichier dans une fenêtre QuickTime.
Afficher dans le Finder : cette option affiche l’emplacement du fichier dans le Finder.
Renommer : cette option active le champ du nom du fichier en champ de texte. 
Il vous suffit alors de renommer le fichier.
Placer dans la Corbeille : cette option déplace le fichier dans la Corbeille.
Pour afficher le contenu d’un fichier dans la pile de fichiers, effectuez 
l’une des opérations suivantes :
m Double-cliquez sur le dossier.
m Sélectionnez le dossier, puis appuyez sur Retour.
Le contenu du dossier remplace l’affichage actuel de la pile de fichiers.
Pour revenir à un dossier visualisé antérieurement, procédez de l’une des manières 
suivantes :
m Cliquez sur le bouton Suivant, situé juste en dessous de la zone de Preview 
(à gauche du menu local Chemin).
m Choisissez un nouveau dossier dans le menu local Chemin situé juste en dessous 
de la zone de prévisualisation.
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Pour renommer un dossier ou un fichier, procédez de l’une des manières suivantes :
m Cliquez sur le fichier ou le dossier en maintenant la touche Contrôle enfoncée, puis 
sélectionnez Renommer dans le menu contextuel. Lorsque le champ de texte devient 
actif, tapez le nouveau nom, puis appuyez sur Retour.
m Dans la pile, cliquez une fois sur le nom du dossier ou du fichier afin de le sélectionner, 
puis cliquez de nouveau dessus pour activer le champ de texte. Tapez le nouveau nom, 
puis appuyez sur la touche Retour.
Pour supprimer un dossier ou un fichier, procédez de l’une des manières suivantes :
m Dans la pile, cliquez sur le fichier avec la touche Contrôle enfoncée, puis choisissez 
Placer dans la Corbeille dans le menu contextuel.
m Faites glisser le fichier de la pile vers l’icône Corbeille dans le Dock.
Organisation de vos fichiers
Vous pouvez organiser les fichiers et dossiers affichés dans le Navigateur de la même 
manière que vous manipulez les fichiers dans le Finder. À cet effet, vous avez la possibilité 
de déplacer des fichiers à l’intérieur ou à l’extérieur des dossiers, ainsi que de créer 
de nouveaux dossiers. Toutes les modifications apportées à la structure des fichiers 
dans Motion se reflètent dans le Finder.
Pour créer un nouveau dossier:
m Cliquez sur le bouton Nouveau dossier situé en bas de la fenêtre.
Pour placer un fichier dans un dossier:
m Faites glisser le fichier sur l’icône du dossier.
Le fichier est déplacé à l’intérieur de ce dossier.
Avertissement : le fait de renommer des dossiers ou des fichiers à partir du Navigateur 
renomme l’élément sur le disque dur ou sur le réseau. Si des projets utilisent les fichiers 
du dossier nommé à l’origine, Motion peut afficher le métrage comme étant manquant.
Avertissement : la suppression de dossiers ou de fichiers dans le Navigateur Motion 
supprime les fichiers du disque dur ou du réseau et place les fichiers dans la Corbeille.126 Chapitre 1 Premiers contacts avec Motion
Présentation par icônes et par liste
La pile de fichiers peut être affichée selon le mode de présentation par icônes ou par 
liste. Chaque mode de présentation offre des avantages en fonction de la situation 
où vous vous trouvez. Certaines options, telles que la taille d’icône, ne concernent 
que la présentation par icônes, tandis que d’autres, telles que le tri par colonnes, 
ne concernent que la présentation par liste.
Pour afficher le Navigateur en mode de présentation par icônes :
m Cliquez sur le bouton Afficher sous forme d’icônes situé à droite du menu local Chemin, 
au-dessus de la barre latérale.
Pour afficher le Navigateur en mode de présentation par liste :
m Cliquez sur le bouton Afficher sous forme de liste situé à droite du menu local Chemin, 
au-dessus de la barre latérale.
Le mode de présentation par icônes permet de contrôler la taille des icônes via 
le curseur de Taille qui se trouve en bas de la fenêtre.
Pour modifier la taille des icônes :
m Faites glisser le curseur Taille vers la droite pour les agrandir ou vers la gauche pour 
les réduire.
En mode de présentation par liste, le contenu du dossier sélectionné est affiché 
sous la forme d’une série de colonnes. Ces colonnes sont intitulées Nom, Date, Taille, 
Durée et Type.
Vous risquez d’être amené à élargir la fenêtre Utilitaire ou à utiliser la case de défilement située en bas de la fenêtre afin de pouvoir visualiser toutes les colonnes.
Présentation par icônes Présentation par liste
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Tri des colonnes
Vous pouvez trier la liste en fonction d’une colonne quelconque. Cela peut être utile 
si vous recherchez un fichier particulier dont vous connaissez la taille approximative 
ou la date de modification.
Pour trier la liste du Navigateur :
m Cliquez sur l’en-tête de la colonne en fonction de laquelle vous souhaitez effectuer le tri.
L’en-tête devient plus foncé et le contenu de la fenêtre est trié en fonction de cette colonne.
Réduction des animations
Il arrive fréquemment que des séquences animées doivent être transmises sous la forme 
d’une série d’images fixes numérotées de manière séquentielle. Motion vous fait gagner 
du temps en vous permettant d’importer ces séquences comme un objet unique dans 
lequel chaque image devient une image séquentielle dans un film.
Pour importer une série d’images fixes numérotées sous la forme d’un seul objet :
1 Cliquez sur le bouton « Afficher les séquences d’images réduites ». 
Le Navigateur affiche plusieurs éléments en les réduisant à un seul objet.
2 Faites glisser l’objet du Navigateur vers le Canevas, l’onglet Couches, la Timeline 
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Remarque : les images provenant d’appareils numériques sont souvent numérotées de 
manière séquentielle, mais ne font pas partie d’une séquence animée. Il est recommandé 
de désactiver cette option pour importer une seule image fixe depuis un appareil 
numérique.
Bibliothèque
Le deuxième onglet proposé par la fenêtre Utilitaire donne accès à la Bibliothèque. 
Elle ressemble au Navigateur, mais au lieu d’afficher les fichiers de votre disque dur, 
elle répertorie l’ensemble des effets, contenus, préréglages, polices, musiques, photos, 
etc. disponibles depuis Motion.
Vous avez la possibilité d’étendre le contenu de la Bibliothèque en y ajoutant certains 
modules, des polices, de la musique ou des photos, ainsi qu’en y sauvegardant le contenu 
créé par vos soins dans Motion et des versions modifiées d’effets intégrés (comme 
des comportements personnalisés ou des animations de caméra).
La Bibliothèque est divisée en trois sections. La section du haut correspond à la zone 
de Preview, le centre est réservé à la barre latérale et la section du bas consiste en 
une pile de fichiers où sont affichés les effets et autres objets.
Zone de Preview de la Bibliothèque
La zone de Preview contient un aperçu visuel, accompagné d’un bouton de lecture 
vous permettant d’afficher les images des séquences animées, ainsi que des prévisualisations des filtres, des comportements, des générateurs, des émetteurs de particules, 
des réplicateurs, etc. Elle contient également des informations textuelles sur l’objet 
sélectionné, comme une description du comportement, du filtre ou du générateur. 
La zone de Preview de la Bibliothèque est quasiment identique à celle du Navigateur, 
mais elle comporte un bouton Appliquer plutôt qu’un bouton Importer.
Remarque : lorsque certains émetteurs de particules sont sélectionnés dans la pile, 
une prévisualisation animée de l’émetteur sélectionné est lue dans la zone de Preview. 
Au cours de la lecture, vous pouvez faire glisser le pointeur autour de la zone de Preview 
afin de voir à quoi ressemble la particule en mouvement.Chapitre 1 Premiers contacts avec Motion 129
Pour visionner le Preview d’un élément tel qu’un réplicateur :
m Dans la Bibliothèque, cliquez sur la catégorie Réplicateurs, sélectionnez une sous-catégorie 
de réplicateurs, puis choisissez dans la pile le réplicateur que vous souhaitez observer.
La prévisualisation commence.
Ajout d’éléments de la Bibliothèque à un projet
Vous disposez de deux méthodes pour ajouter des éléments de la Bibliothèque 
à un projet. Vous pouvez soit faire glisser directement un objet dans votre projet, 
soit sélectionner un élément dans la pile de la Bibliothèque, puis cliquer sur le 
bouton Appliquer dans la zone de Preview.
Remarque : en ce qui concerne les comportements et les filtres, vous disposez même 
d’une troisième possibilité. Vous pouvez sélectionner un ou plusieurs objets d’un projet, 
puis cliquer sur le bouton Ajouter comportement ou Ajouter filtre dans la barre d’outils. 
Vous pouvez également créer des particules et des réplicateurs personnalisés (à partir 
d’une couche présente dans votre projet) en cliquant sur le bouton Générer des particules ou Réplicateur de la barre d’outils. Pour en savoir plus sur la création de systèmes 
de particules personnalisés, voir « Création d’un système de particules simple et 
personnalisé » à la page 750. Pour en savoir plus sur la création de réplicateurs personnalisés, voir « Création d’un motif de réplicateur personnalisé simple » à la page 825.
Pour appliquer un élément à un groupe, une couche ou un objet :
1 Sélectionnez l’objet (dans le Canevas, l’onglet Couches ou la liste de couches 
de la Timeline) auquel vous souhaitez appliquer l’effet.
2 Sélectionnez un effet dans la Bibliothèque.
Par exemple, cliquez sur la catégorie Filtres, sélectionnez une sous-catégorie de filtres, 
puis choisissez dans la pile le filtre à appliquer.
3 Cliquez sur le bouton Appliquer dans la zone de Preview. 
L’effet est ajouté à l’objet.
Vous pouvez également faire glisser un effet de la Bibliothèque directement 
sur un objet dans le Canevas, l’onglet Couches ou la Timeline.
Pour ajouter un élément à un projet :
1 Sélectionnez le groupe (dans l’onglet Couches ou la liste de couches de la Timeline) 
auquel vous souhaitez ajouter l’effet.
2 Sélectionnez un effet dans la Bibliothèque.
Par exemple, cliquez sur la catégorie Émetteurs de particules, sélectionnez 
une sous-catégorie, puis choisissez dans la pile l’émetteur à appliquer.
3 Cliquez sur le bouton Appliquer dans la zone de Preview.
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Vous pouvez également faire glisser un effet de la Bibliothèque directement dans 
le Canevas, l’onglet Couches ou la Timeline. Pour en savoir plus sur l’emplacement 
et la réorganisation des objets dans un projet, voir « Organisation des groupes et des 
couches dans Motion » à la page 260.
Barre latérale
La section centrale de la Bibliothèque contient des commandes de navigation ainsi 
qu’une liste de dossiers de types d’effets disponibles dans Motion. 
Cliquez sur un dossier de la barre latérale pour en afficher le contenu dans la pile 
de fichiers située en dessous. Plusieurs commandes situées au-dessus des catégories 
de la Bibliothèque dans la barre latérale permettent de naviguer parmi les éléments 
affichés dans la fenêtre et de les trier.
Boutons Précédent et Suivant: ces boutons permettent de naviguer à travers les dossiers 
récents. Ils fonctionnent de la même manière que les boutons Suivant et Précédent 
d’une fenêtre de navigateur Web.
Menu local Chemin: affiche la hiérarchie du système de fichiers (imbrication des dossiers) 
du dossier ouvert.
Boutons Présentation par icônes et Présentation par liste : permet de contrôler le mode 
de présentation de la pile de fichiers. Cliquez sur le bouton de gauche pour sélectionner le 
mode de présentation par icône. Cliquez sur le bouton de droite pour sélectionner le 
mode de présentation par liste.
Boutons Affichage
Boutons Suivant/Précédent
Menu local Chemin
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Menu local Thème : permet de trier et d’organiser le contenu de la Bibliothèque 
par thèmes. Vous pouvez choisir un thème existant ou créer un thème personnalisé 
et y ajouter du contenu. Il est possible d’ajouter les éléments suivants à un thème :
Â Réplicateurs
Â Émetteurs
Â Formes
Â Dégradés
Â Styles de texte
Â Styles de forme
Â Couches ou groupes
Remarque : il est impossible d’ajouter des comportements, des filtres, des polices, 
des polices LiveFonts, des images, des séquences d’images et des films à un thème. 
Toutefois, vous pouvez ajouter à un thème des couches et des groupes contenant 
ces types d’éléments.
Pour créer un nouveau thème personnalisé :
1 Choisissez Nouveau thème dans le menu local Thème.
2 Dans la zone de dialogue Créer un nouveau thème, attribuez un nom à votre thème, 
puis cliquez sur OK.
Un nouveau thème est alors ajouté. Les nouveaux thèmes sont affichés dans le menu 
local Thème.
Les thèmes personnalisés sont enregistrés dans un fichier « theme » du dossier /Utilisateurs/
nom d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/Motion/Bibliothèque.
Pour ajouter du contenu à un thème :
m Cliquez sur un élément de la Bibliothèque tout en maintenant la touche Contrôle 
enfoncée, choisissez Thème dans le menu contextuel, puis sélectionnez le thème 
dans lequel vous souhaitez enregistrer l’élément.
Remarque : pour pouvoir ajouter un élément à un thème, cet élément doit être 
enregistré dans la Bibliothèque. Pour en savoir plus sur l’enregistrement d’éléments 
dans la Bibliothèque, voir « Enregistrement et partage d’éléments de la Bibliothèque 
personnalisés » à la page 136.
Pour effectuer un tri à l’aide du menu local Thème, procédez de l’une 
des manières suivantes :
m Sélectionnez une catégorie dans la Bibliothèque, puis choisissez un thème dans 
le menu local Thème.
m Pour effectuer un tri sur des thèmes par défaut, sélectionnez la catégorie Contenu, 
puis choisissez le thème Folio, Traditions ou Apprentissage dans le menu local Thème.
Les thèmes par défaut sont enregistrés dans un fichier « themes » du dossier /Bibliothèque/
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Pour supprimer un thème :
1 Choisissez le thème que vous souhaitez supprimer dans le menu local Thème.
Le menu local Thème vous propose alors l’option « Supprimer le thème ».
2 Choisissez Supprimer le thème dans le menu local Thème.
Le thème est supprimé de la liste.
Remarque : vous ne pouvez supprimer que des thèmes personnalisés.
Champ de recherche : filtre le contenu de la pile de fichiers, afin de n’inclure que 
les objets dont les noms contiennent le texte saisi dans le champ de recherche.
Remarque : les dossiers ne contenant aucune correspondance sont ignorés.
Pour effacer le champ de recherche :
m Cliquez sur le bouton Effacer situé à droite du champ de recherche.
Contenu de la Bibliothèque
La Bibliothèque contient tous les effets, préréglages, polices et autres éléments disponibles depuis Motion. Ces éléments sont regroupés en catégories affichées à gauche de 
la barre latérale. La sélection de l’une ou l’autre de ces catégories permet d’afficher une 
liste de sous-catégories à droite. La Bibliothèque contient également deux autres caté-
gories (Musique et Photos) qui permettent l’accès à vos bibliothèques iTunes et iPhoto.
Pour en savoir plus sur l’ajout d’éléments de la Bibliothèque à votre projet, 
voir « Ajout d’éléments de la Bibliothèque à un projet » à la page 129.
La Bibliothèque comporte les catégories suivantes :
Comportements : contient les comportements Audio, Animation standard, Caméra, Suivi 
de l’animation, Paramètre, Particules, Réplicateur, Resynchronisation, Forme, Simulations, 
Animation de texte et Séquence de texte. Ces différents comportements s’appliquent à 
des types d’objets spécifiques. Ainsi, vous ne pouvez appliquer les comportements Animation de texte et Séquence de texte qu’à du texte. Pour en savoir plus sur l’application des 
comportements, voir « Application et suppression de comportements » à la page 410.
Filtres : cette catégorie contient tous les effets de filtre intégrés, répartis en sous-catégories individuelles. Vous pouvez appliquer la majeure partie des filtres à toutes les couches 
(images, texte, formes, séquences, particules, etc.) ou masques de votre projet.
Filtres de tierce partie : contient tous les filtres compatibles avec Motion mais fabriqués 
par des tiers.
Images (filtres) : contient tous les modules installés sur votre ordinateur et basés sur 
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Générateurs : contient une sélection de damiers, de bruits de fond, de rayons de 
couleur et d’autres éléments générés par ordinateur, à utiliser dans vos projets.
Images (générateurs) : contient tous les générateurs installés sur votre ordinateur 
et basés sur le traitement Core Image.
Émetteurs de particules : contient une sélection de préréglages de systèmes d’émission de particules répartis en sous-catégories.
Réplicateurs : contient une sélection de réplicateurs de préréglage répartis 
en sous-catégories.
Formes : contient une collection de formes prédéfinies. Vous pouvez ajouter 
des formes à votre projet comme s’il s’agissait de tout autre objet.
Dégradés : contient une sélection de préréglages de dégradés que vous pouvez 
appliquer aux couches ou au texte. Pour ce faire, il vous suffit de faire glisser un 
dégradé directement sur une forme ou un texte ou de commencer par sélectionner 
une couche ou un texte de votre projet, de sélectionner un dégradé dans la Bibliothè-
que, puis de cliquer sur Appliquer.
Polices : contient toutes les polices disponibles sur votre système, ce qui inclut à la fois 
les polices TrueType et Type 1. Vous pouvez faire glisser une police directement sur un 
texte ou commencer par sélectionner un texte de votre projet, sélectionner une police 
dans la Bibliothèque, puis cliquer sur Appliquer. Pour en savoir plus sur les changements 
de polices dans ce navigateur, voir « Changement de police » à la page 628.
LiveFonts : contient toutes les polices LiveFonts installées sur votre système. Elles ne sont 
applicables qu’aux objets texte. Pour en savoir plus, voir « Utilisation de polices LiveFonts » 
à la page 738.
Styles de texte : contient une collection de styles de texte prédéfinis que vous pouvez 
appliquer au texte. Pour ce faire, il vous suffit de faire glisser un style de texte directement 
sur un texte ou de commencer par sélectionner un texte de votre projet, de sélectionner 
un style de texte dans la Bibliothèque, puis de cliquer sur Appliquer. Les styles de texte 
apparaissent également dans l’Inspecteur Texte. Pour en savoir plus, voir « Utilisation et 
création de styles de texte » à la page 674.
Styles de forme : contient une collection de styles de forme prédéfinis que vous pouvez 
appliquer à des formes. Pour ce faire, il vous suffit de faire glisser un style de forme 
directement sur une forme ou de commencer par sélectionner une forme de votre projet, 
de sélectionner un style de forme dans la Bibliothèque, puis de cliquer sur Appliquer. 
Les styles de forme apparaissent également dans la palette de l’outil Trait de peinture 
et l’Inspecteur Forme. Pour en savoir plus, voir « Utilisation des formes et des masques » 
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Musique : cette catégorie Bibliothèque permet de rechercher et d’importer des fichiers 
audio directement à partir de votre bibliothèque iTunes. Les sous-catégories Musique 
incluent la bibliothèque et les éventuelles listes de lecture créées dans iTunes. Le contenu de chaque liste de lecture apparaît dans la pile de fichiers. Lorsqu’elle est affichée 
en présentation par liste, la catégorie Musique affiche les informations Nom, Artiste, 
Album, Durée et Taille créées dans iTunes.
Remarque : les fichiers AAC avec protection des droits ne peuvent pas être importés 
dans Motion et n’apparaissent pas dans la pile de fichiers. Cela concerne toute la musique 
achetée dans la boutique iTunes. Il est impossible d’importer tout contenu vidéo 
en provenance d’iTunes dans un projet Motion.
Photos : cette catégorie Bibliothèque permet de rechercher et d’importer des fichiers 
image directement à partir de votre bibliothèque iPhoto. Les sous-catégories Photos 
incluent la bibliothèque et les éventuels albums créés dans iPhoto. Le contenu de chaque 
album apparaît dans la pile de fichiers.
Remarque : lors de l’importation d’une image de grande taille dans Motion, vous avez 
la possibilité d’importer le fichier tel quel, d’adapter l’image à la taille du Canevas ou 
de changer sa résolution en fonction du Canevas. Pour en savoir plus, voir « Utilisation 
d’images fixes à haute résolution » à la page 228.
Contenu : contient des éléments individuels utilisés dans les modèles et autres préréglages. Ils peuvent servir à créer vos propres éléments personnalisés, tels que des systèmes 
de particules et des réplicateurs, que vous pouvez enregistrer dans la Bibliothèque 
pour un usage ultérieur.
Favoris : comme vous pouvez créer des versions personnalisées de tous les types 
d’effets, y compris les systèmes de particules, les filtres, courbes d’animation, caméras, 
groupes ou couches personnalisés, vous avez la possibilité de les stocker dans le dossier 
Favoris. Vous pouvez également ajouter des raccourcis vers les éléments fréquemment 
utilisés. Par défaut, ce dossier est vide.
Remarque : la zone de Preview n’affiche pas les descriptions des préréglages intégrés 
copiés dans la catégorie Favoris. Pour ajouter une description affichée dans la zone 
de Preview de la Bibliothèque, cliquez sur le favori en maintenant la touche Contrôle 
enfoncée, puis choisissez Modifier la description dans le menu contextuel.
Menu Favoris : il s’agit d’une autre catégorie de favoris. Les éléments stockés dans 
ce dossier apparaissent dans le Menu Favoris de la barre des menus.
Pile de fichiers
La section inférieure de la Bibliothèque affiche le contenu du dossier sélectionné dans la 
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Pour afficher le contenu d’un fichier dans la pile de fichiers, effectuez l’une 
des opérations suivantes :
m Double-cliquez sur le dossier.
m Sélectionnez le dossier, puis appuyez sur Retour.
Le contenu du dossier remplace l’affichage actuel de la pile de fichiers.
Pour revenir à un dossier visualisé antérieurement, procédez de l’une des manières 
suivantes :
m Cliquez sur le bouton Précédent situé directement sous la zone de prévisualisation.
m Choisissez un nouveau dossier dans le menu local Chemin situé juste en dessous 
de la zone de prévisualisation.
m Appuyez sur les touches Commande + Flèche vers le haut.
Organisation de vos effets
Vous pouvez organiser les effets, les objets et dossiers affichés dans la Bibliothèque 
comme vous manipulez les fichiers dans le Finder. À cet effet, vous avez la possibilité 
de déplacer des effets et des objets à l’intérieur ou à l’extérieur des dossiers, de créer 
de nouveaux dossiers, ainsi que de supprimer des fichiers ou des dossiers.
Remarque : vous ne pouvez pas modifier les objets et les dossiers intégrés à Motion.
Pour créer un nouveau dossier:
m Cliquez sur le bouton Nouveau dossier situé en bas de la fenêtre.
Un nouveau dossier est ajouté à la sous-catégorie actuelle de la Bibliothèque.
Pour en savoir plus sur l’organisation des dossiers et du contenu personnalisés, 
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Présentation par icônes et par liste
La pile de fichiers peut être affichée selon le mode de présentation par icônes 
ou par liste.
Pour afficher la Bibliothèque en mode de présentation par icônes :
m Cliquez sur le bouton Afficher sous forme d’icônes situé à droite du menu local Chemin, 
au-dessus de la barre latérale.
Pour afficher la Bibliothèque en mode de présentation par liste :
m Cliquez sur le bouton Afficher sous forme de liste situé à droite du menu local Chemin, 
au-dessus de la barre latérale.
Le mode de présentation par icônes permet de contrôler la taille des icônes via 
le curseur de Taille qui se trouve en bas de la fenêtre.
Pour modifier la taille des icônes :
m Faites glisser le curseur Taille vers la droite pour les agrandir ou vers la gauche pour 
les réduire. 
Enregistrement et partage d’éléments de la Bibliothèque personnalisés
Vous pouvez enregistrer quasiment tous les objets de Motion dans la Bibliothèque, 
y compris des caméras et des lumières animées, des filtres, des comportements, des 
systèmes de particules, des réplicateurs, des formes et des textes personnalisés, ainsi 
que des groupes et des couches. Pour enregistrer un objet en vue de l’utiliser plus tard, 
faites-le glisser dans un dossier existant de la Bibliothèque ou dans un nouveau dossier. Dès lors qu’il est placé dans la Bibliothèque, un objet peut être ajouté à un projet 
comme n’importe quel autre objet de la Bibliothèque.
Présentation par icônes Présentation par liste
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Vous pouvez enregistrer de multiples objets dans la Bibliothèque sous la forme d’un seul 
ou de plusieurs fichiers. Par exemple, si vous créez un effet à partir de plusieurs filtres et 
que vous souhaitez sauvegarder leur effet cumulé afin de les appliquer ultérieurement 
à d’autres objets, vous pouvez enregistrer tous les filtres sous la forme d’un seul élément 
dans la Bibliothèque.
Bien que vous puissiez enregistrer vos objets personnalisés dans les dossiers prévus à cet 
effet (catégories de même nom), il est généralement recommandé de placer les objets 
que vous utilisez le plus fréquemment dans la catégorie Favoris. En effet, certaines caté-
gories de la Bibliothèque de Motion contiennent tellement d’éléments que vous gagnerez du temps dans vos recherches si vous recourez à la catégorie Favoris ou Menu Favoris. 
Vous pouvez d’ailleurs créer d’autres dossiers au sein de la catégorie Favoris afin d’organiser au mieux vos éléments personnalisés.
Remarque : vous pouvez créer de nouveaux dossiers dans les catégories intégrées, 
comme la sous-catégorie de filtres Étalonnage. Toutefois, ces dossiers apparaissent uniquement dans la pile de la Bibliothèque, mais pas dans la barre latérale. Quant aux dossiers 
créés dans la catégorie Favoris, ils apparaissent dans la barre latérale de la Bibliothèque.
Pour enregistrer un objet dans la Bibliothèque :
1 Ouvrez la Bibliothèque, puis sélectionnez la catégorie Favoris, Menu Favoris 
ou une autre.
2 Faites glisser l’objet personnalisé à enregistrer de l’onglet Couches, de la Timeline 
ou de l’Inspecteur dans la pile au bas de la Bibliothèque.
Les objets enregistrés dans la catégorie Menu Favoris s’appliquent très rapidement 
à des objets grâce au menu Favoris.
Lorsque vous enregistrez un objet personnalisé, il est sauvegardé dans le dossier 
/Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/
Motion/Bibliothèque.
Remarque : si vous faites glisser des éléments vers une catégorie inappropriée, ils sont 
automatiquement placés dans la catégorie qui leur correspond. Par exemple, si vous 
faites glisser un comportement personnalisé vers la catégorie Filtres, il est automatiquement placé dans la catégorie Comportements, qui est alors activée.
Pour enregistrer plusieurs objets dans la Bibliothèque :
1 Ouvrez la Bibliothèque, puis sélectionnez la catégorie Favoris, Menu Favoris ou une autre.
2 Dans l’onglet Couches, sélectionnez tous les objets que sous souhaitez enregistrer, 
faites-les glisser dans la pile et maintenez le bouton de la souris enfoncé.
3 Lorsque le menu déroulant apparaît, choisissez « Tous dans un fichier » 
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L’option « Tous dans un fichier » enregistre tous les objets ensemble et ils sont ensuite 
répertoriés comme un seul élément dans la Bibliothèque. À l’inverse, l’option « Fichiers 
multiples » enregistre les objets dans la Bibliothèque comme des éléments individuels.
4 Pour attribuer un nom au(x) fichier(s), procédez de l’une des manières suivantes :
Â Cliquez sur son icône tout en maintenant la touche Contrôle enfoncée, choisissez 
Renommer dans le menu contextuel, puis saisissez un nom descriptif.
Â Sélectionnez l’icône, cliquez sur « sans titre », puis tapez un nom descriptif.
si vous cliquez sur l’icône tout en maintenant la touche Contrôle enfoncée, l’option Modifier la description apparaît. Il s’agit d’un outil très pratique qui vous permet de rédiger des 
notes personnelles sur un élément enregistré dans la Bibliothèque. Après avoir choisi 
Modifier la description, saisissez vos notes dans le champ de texte, puis cliquez sur OK.
Inspecteur
Chaque effet de Motion (des comportements aux dégradés, en passant par les systèmes 
de particules) est contrôlé par un ensemble de paramètres qui modifient les différents 
attributs de cet effet. Un filtre Flou, par exemple, possède un curseur qui permet d’ajuster 
la quantité de flou appliquée.
Certains paramètres sont contrôlés à l’aide de curseurs, d’autres via des cadrans 
ou des menus locaux. Il existe en fait des milliers de paramètres utilisant de multiples 
types de commandes. Tous ces éléments sont accessibles via l’Inspecteur.
Important : l’Inspecteur est contextuel : son affichage dépend de l’objet sélectionné. 
D’ailleurs, vous devez avoir sélectionné un objet pour que l’Inspecteur affiche 
les paramètres correspondants.
Même les objets dépourvus d’effets possèdent de nombreux paramètres que 
vous pouvez modifier pour altérer leur nature et leur comportement dans votre projet. 
Ces paramètres comprennent l’échelle, l’opacité et la position à l’écran de l’objet, ainsi 
que des attributs moins évidents, tels que ses proportions pixel ou son ordre de trame.
L’Inspecteur comporte quatre onglets, chacun regroupant des paramètres de l’objet 
sélectionné. Les trois premiers, Propriétés, Comportements et Filtres, sont présents 
quel que soit l’objet sélectionné. Le quatrième, communément appelé « onglet Objet », 
change de nom et de contenu en fonction du type de l’objet sélectionné.
Types de commandes
Il existe un grand nombre de commandes apparaissant dans l’Inspecteur. Chacune 
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Les divers types d’objets et d’effets nécessitant des paramètres variés, l’Inspecteur affiche 
des ensembles de commandes différents selon l’élément sélectionné. Le tableau suivant 
décrit les différents types de commandes et vous explique comment les utiliser.
Commande Type de commande Description
Curseur Il suffit de le faire glisser pour modifier 
la valeur du paramètre correspondant. 
Un déplacement vers la droite permet 
généralement d’augmenter la valeur, 
tandis qu’un déplacement vers la gauche 
la diminue. Le paramètre Échelle, 
par exemple, utilise un curseur.
Vous pouvez cliquer à gauche ou à droite 
du marqueur avec la touche Option 
enfoncée afin d’augmenter ou de réduire 
la valeur de 1.
De nombreux curseurs comportent un 
triangle d’affichage sur lequel vous pouvez 
cliquer pour afficher des sous-paramètres 
détaillés.
Curseur de valeur Type spécial de curseur intégrant la valeur 
du paramètre. Il fonctionne comme un curseur ordinaire par déplacement de la partie 
centrale (contenant la valeur) ; un déplacement vers la droite augmente la valeur, 
tandis qu’un déplacement vers la gauche 
la diminue. Certains paramètres permettent 
d’augmenter ou de diminuer indéfiniment 
la valeur. Vous pouvez également cliquer 
sur la flèche située à droite ou à gauche 
pour modifier la valeur par incréments 
d’une unité. Si vous maintenez enfoncée 
la touche Option tout en cliquant sur l’une 
de ces flèches, vous augmentez ou diminuez la valeur de 0,01. Vous pouvez doublecliquer sur la valeur elle-même pour convertir le curseur en champ, afin d’y taper directement une valeur spécifique. Le paramètre 
Position constitue un exemple de paramè-
tre utilisant le curseur de valeur.
De nombreux curseurs comportent 
un triangle d’affichage sur lequel vous 
pouvez cliquer pour afficher des sousparamètres détaillés.
Remarque : Lorsqu’un curseur de valeur 
ou un champ de valeur est sélectionné, 
appuyez sur la touche Tab pour le déplacer 
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Cadran Commande utilisée pour les valeurs se 
rapportant à des angles ou des degrés. 
Tournez le cadran en le faisant glisser 
dans un sens ou dans l’autre. Le paramètre 
Rotation constitue un exemple de paramètre 
utilisant un cadran.
Champ de valeur Commande permettant de taper directement 
la valeur du paramètre. Le champ Entrée de 
texte constitue un exemple de paramètre 
utilisant un champ de valeur.
Menu local Menu comprenant des valeurs prédéfinies. 
Cliquez sur le menu, puis choisissez 
la valeur souhaitée. Le paramètre Incrémentation du comportement Lancer constitue 
un parfait exemple de menu local.
Liste de valeurs Autre type de menu local. Vous pouvez 
cliquer sur la flèche située à droite du 
champ pour afficher les valeurs prédéfinies 
ou taper une valeur directement dans 
le champ. Le paramètre Style constitue 
un exemple de liste de valeurs.
Case d’activation Commande permettant d’activer ou 
de désactiver un paramètre. Le paramètre
Conserver l’opacité constitue un exemple 
de case d’activation.
Cadre de couleur Zone sur laquelle vous cliquez pour ouvrir 
la fenêtre Couleurs. Vous pouvez également 
cliquer avec la touche Contrôle enfoncée 
afin de sélectionner une couleur dans la 
palette de couleurs qui apparaît (illustrée), 
ou cliquer sur le triangle d’affichage afin 
de manipuler les curseurs R, V, B et A individuels. Le paramètre Couleur de remplissage
d’une forme en est un parfait exemple.
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Outre les types de commandes de paramètres habituels présentés ci-dessus, il existe 
plusieurs autres types de commandes largement utilisés dans l’onglet Inspecteur.
Éditeur de dégradé Cette commande permet de sélectionner 
un style de dégradé prédéfini ou d’en créer 
un nouveau. En présentation réduite, 
vous ne pouvez choisir un préréglage 
qu’à partir du menu local Préréglage. 
Vous pouvez également cliquer sur 
le triangle d’affichage afin de révéler des 
commandes supplémentaires permettant 
de définir l’opacité du dégradé, ainsi que 
ses valeurs de couleur. La fenêtre Style 
de texte affiche un éditeur de dégradé 
lorsque le paramètre Face « Remplir avec » 
est réglé sur Dégradé.
Cadre d’image Cette zone vous permet de déposer un 
objet (généralement un plan, une image fixe 
ou une forme), afin de fournir des données 
d’entrée à un type d’effet. Par exemple, 
un filtre Relief a besoin d’une image 
pour créer des reliefs et un comportement 
Repousser doit savoir quel objet utilisé 
pour repousser les autres. Le comportement 
Attiré vers du paramètre Objet constitue 
un parfait exemple de l’utilisation du cadre 
d’image.
Menu de sélection 
de paramètre
Type spécial de menu local réservé aux 
comportements Paramètre. Si vous appliquez 
un comportement Paramètre à un objet, 
vous devez identifier le paramètre que 
ce comportement doit affecter. Vous pouvez 
soit saisir directement le nom du paramètre 
dans le champ, soit choisir un paramètre 
dans la liste des paramètres actuels proposée par le menu local Aller. Le paramètre 
Appliquer à du comportement Moyenne 
constitue un exemple de menu de sélection 
de paramètre.
Menu local de 
sélection de suivi
Semblable au menu de sélection de paramè-
tre, ce menu vous permet de sélectionner 
des données de suivi existantes stockées 
dans un autre comportement Suivi de 
l’animation, afin de les appliquer au 
comportement de suivi actuellement sélectionné. Le menu local Source
du comportement Suivre le mouvement 
en est un parfait exemple.
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Bouton Réinitialiser : rétablit automatiquement la valeur par défaut du paramètre 
(ou dans certains cas, d’un ensemble de paramètres).
Menu local Préréglage : la Bibliothèque contient des préréglages de styles que 
vous pouvez appliquer aux formes ou au texte. Le menu local Préréglage de style 
vous permet d’appliquer un préréglage de style au texte sélectionné. Quant au menu 
local Style de forme, il vous permet d’appliquer un de style à la forme sélectionnée 
(y compris les traits de peinture). Vous pouvez également enregistrer des préréglages personnalisés de formes et de texte dans la Bibliothèque grâce à ce menu local.
Par exemple, le menu local Préréglage Style affiché par la fenêtre Style de texte vous 
permet d’enregistrer un style de texte, un format, voire les deux (les paramètres définis 
dans les fenêtres Format et Style).
Pour en savoir plus sur l’utilisation des styles de texte, voir « Enregistrement d’un style 
de texte personnalisé » à la page 677.
Pour enregistrer un préréglage :
1 Définissez les valeurs de paramètre des réglages que vous souhaitez enregistrer.
2 Sélectionnez Enregistrer dans le menu local Préréglage Style. 
Une zone de dialogue s’ouvre.
3 Tapez un nom pour le préréglage à enregistrer, puis cliquez sur Enregistrer. 
Le préréglage est désormais stocké dans la bibliothèque, dans la catégorie appropriée. 
Il apparaît dans le menu local Préréglage Style, pour ce projet et les projets antérieurs, 
tant que vous ne le supprimez pas manuellement dans le Finder.
Pour appliquer un préréglage existant :
m Choisissez le préréglage souhaité dans le menu local Préréglage Style.
Les réglages de paramètre actuels sont remplacés par ceux du préréglage.
Bouton Réinitialiser
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Menu Animation : la plupart des paramètres peuvent être animés. Cela signifie que vous 
pouvez attribuer des valeurs spécifiques à certaines images (images clés) afin que la valeur 
du paramètre évolue dans le temps. Tous les paramètres capables d’être animés possèdent 
un menu Animation situé à droite de leurs réglages.
Le menu Animation affiche une icône différente en fonction de l’état actuel 
du paramètre. Pour consulter un tableau décrivant ces différents états, voir 
« États du menu Animation » à la page 110.
Cliquez sur le menu Animation pour afficher un menu local proposant des options 
d’animation.
Activer/Désactiver l’animation : cette commande demeure indisponible jusqu’à 
ce qu’une animation par images clés soit appliquée au paramètre soit via le bouton 
Enregistrer, soit en ajoutant directement une image clé. Dès que le paramètre est 
animé, le nom de la commande de menu devient automatiquement « Désactiver 
l’animation ». Si vous l’activez à ce stade, vous cachez vraiment les images clés que 
vous avez définies et vous restaurez le paramètre sur sa valeur par défaut. Toutefois, 
les images clés ne sont pas supprimées. Si vous sélectionnez Activer l’animation à 
nouveau, le canal est restauré sur son état animé avec des images clés le plus récent
Réinitialiser le paramètre : supprime toutes les images clés et les réglages pour ce 
paramètre. La valeur du paramètre est réinitialisée sur sa valeur par défaut.
Ajouter une image clé : ajoute une image clé à l’image actuelle. Si la tête de lecture est 
placée sur une image à laquelle une image clé a déjà été ajoutée, cet élément de menu 
n’est pas disponible. Vous pouvez également cliquer sur le menu Animation tout en 
maintenant la touche Option enfoncée pour ajouter une image clé.
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Remarque : vous pouvez utiliser le raccourci clavier Contrôle + K pour ajouter rapidement 
une image clé. Une image clé est automatiquement ajoutée au paramètre de la couche 
modifié en dernier.
Supprimer l’image clé : supprime l’image clé actuelle. La commande Supprimer l’image 
clé n’est disponible que si la tête de lecture est placée sur une image contenant 
une image clé.
Image clé précédente : place la tête de lecture sur l’image clé précédente de ce paramètre. La commande Image clé précédente n’est disponible que si une image clé existe 
plus tôt dans le projet.
Image clé suivante : place la tête de lecture sur l’image clé suivante de ce paramètre. 
La commande Image clé suivante n’est disponible que si une image clé existe plus loin 
dans le projet.
Afficher dans l’Éditeur d’images clés : ouvre l’Éditeur d’images clés s’il n’est pas 
encore visible et affiche le graphique correspondant au paramètre que vous êtes 
en train de modifier.
Indicateur de tramage
Dans l’onglet Propriétés de l’Inspecteur, un petit « voyant » apparaît si un groupe est 
tramé. Il s’agit d’un indicateur de tramage. Comme son nom l’indique, il sert à indiquer 
qu’un groupe est tramé, mais ce n’est en aucun cas une commande. 
Certaines opérations, tout comme l’application de divers filtres ou d’un masque, provoquent le tramage du groupe concerné. Lorsqu’il est tramé, un groupe est converti 
en image bitmap. Le tramage affecte les groupes 2D et 3D différemment. Lorsqu’un 
groupe 2D est tramé, les modes de fusion appliqués aux objets au sein du groupe n’ont 
plus aucune interaction avec les objets situés en dehors du groupe. Par ailleurs, si 
un groupe 3D est tramé, l’intégralité du groupe ne peut plus avoir aucune interaction 
avec les objets situés en dehors. Le groupe 3D tramé est alors traité comme un objet 
unique et il utilise l’ordre des couches, plutôt que l’ordre de profondeur, pour composer 
le projet.
Dès qu’une opération déclenche le tramage d’un groupe, l’indicateur de tramage 
apparaît en regard du paramètre dans l’onglet Propriétés.
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De plus, un petit cadre apparaît autour de l’icône représentant le groupe 2D ou 3D 
(à gauche de son nom) dans l’onglet Couches et la liste de couches de la Timeline.
Pour en savoir plus sur le tramage, voir « compositing 3D » dans le manuel Motion 
Supplemental Documentation PDF.
Onglets Inspecteur
Les paramètres figurant dans l’Inspecteur sont regroupés en quatre catégories.
Propriétés : cet onglet contient les attributs de base de l’objet sélectionné, notamment 
les commandes Transformation (position, échelle, rotation, etc.), Fusion (opacité, mode 
de fusion, etc.), Ombre portée, Quatre angles, Rognage, ainsi que les points d’entrée 
et de sortie de la couche.
Remarque : en fonction du type d’objet sélectionné, différents paramètres sont 
également disponibles dans l’onglet Propriétés. Par exemple, si vous sélectionnez 
un groupe 3D, le paramètre Éclairage apparaît et les paramètres Rognage, Ombre 
portée et Quatre angles disparaissent.
Comportements : si vous avez appliqué des comportements à un objet, les paramètres 
associés à ces comportements apparaissent dans cet onglet dès lors que cet objet est 
sélectionné. Les comportements multiples sont regroupés par le nom du comportement.
Filtres : dès qu’un filtre (ou un masque) est appliqué à une couche, les paramètres 
associés à ce filtre apparaissent dans cet onglet. Les filtres multiples sont regroupés 
par le nom du filtre.
Objet : le contenu et le titre de cet onglet varient en fonction du type d’objet sélectionné. Les différents types d’objet sont décrits ci-dessous :
Â Objet : cet onglet apparaît uniquement si aucun objet n’est actuellement sélectionné. Il n’affiche aucun paramètre.
Â Image : apparaît uniquement si une image, une séquence d’images ou une séquence 
est sélectionnée. Cet onglet contient la case à cocher Zone de dépôt, dont l’activation 
ou la désactivation détermine si l’image sélectionnée est oui ou non la cible d’une zone 
de dépôt. Le paramètre Ajuster indique la méthode utilisée pour dimensionner une 
couche déposée au sein d’une zone de dépôt, alors que le bouton Effacer supprime la 
couche de référence de la zone de dépôt. Pour en savoir plus, voir « Zones de dépôt » à 
la page 280.
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Â Groupe : apparaît uniquement si un groupe est sélectionné. Cet onglet contient 
le paramètre Type qui vous permet de convertir un groupe 2D en 3D et inversement. 
Les groupes 2D et 3D mettent à disposition des paramètres différents.
Si le groupe est réglé sur 3D, les paramètres supplémentaires Aplatir et Ordre de 
couche apparaissent. Pour aplatir un groupe 3D et le rendre aussi plat qu’une simple 
carte, il vous suffit de cocher la case Aplatir. En revanche, si vous cochez la case Ordre 
de couche, les éléments de projet sont triés selon leur ordre d’apparition dans la liste 
de couches et non selon leur positionnement le long de l’axe Z (en espace tridimensionnel). Pour en savoir plus, voir « compositing 3D » dans le manuel Motion Supplemental Documentation PDF.
Si le groupe est réglé sur 2D, le paramètre Résolution est affiché. Il vous permet 
de définir manuellement la taille d’un groupe. Par défaut, l’option Résolution fixe 
est désactivée et la taille du groupe dépend des couches qu’il contient. Pour en 
savoir plus, voir « Définition de la taille d’un groupe » à la page 272.
Remarque : si le paramètre Résolution fixe est activé, le groupe est rogné à la taille 
spécifiée dans les paramètres Largeur fixe et Hauteur fixe autour de son point 
d’ancrage.
Â Caméra : apparaît uniquement si une caméra est sélectionnée. Cet onglet contient 
des commandes propres à une caméra, notamment le type de caméra et son angle 
de vue, et des paramètres relatifs aux plans et aux fondus. Pour en savoir plus sur 
l’utilisation des caméras, voir « compositing 3D » dans le manuel Motion Supplemental Documentation PDF.
Remarque : une caméra de scène est une caméra ajoutée à un projet, contrairement 
à une présentation de caméra par défaut que vous pouvez choisir dans le coin supé-
rieur gauche du Canevas (comme Haut, Droite ou Perspective).
Â Éclairage : apparaît si une table lumineuse est sélectionnée. Cet onglet contient des 
commandes vous permettant de régler le type de lumière, la couleur, l’intensité, etc.
Â Média : apparaît uniquement si un objet est sélectionné dans l’onglet Média. 
Ces paramètres traitent généralement des attributs du fichier sur le disque ou 
de la manière dont le fichier est interprété par Motion. Comme plusieurs objets 
d’un projet peuvent faire référence au même fichier de média, cet onglet contient 
une liste des objets liés, comprenant le nom du groupe où ils sont situés. Les modifications effectuées dans cet onglet ont un impact sur tous les objets qui se réfè-
rent au fichier de média sélectionné. Pour en savoir plus sur l’utilisation des 
paramètres des médias, voir « Paramètres d’objet disponibles dans l’onglet Média » à 
la page 250.
Â Texte : affiché uniquement si une couche de texte est sélectionnée, cet onglet 
contient toutes les commandes nécessaires pour modifier du texte. Il est divisé 
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Â Format : contient des commandes standard destinées à contrôler la police, 
la taille, l’approche de groupe, le crénage, etc. Elle contient également un grand 
champ d’entrée de texte, l’éditeur de texte, dans lequel vous pouvez modifier 
le contenu du texte sélectionné (outre les possibilités de modification à l’écran).
Â Style : contrôle la couleur, la texture et d’autres attributs similaires du style, de 
la structure, de l’éclat et de l’ombre portée. Chacune de ces sections est groupée 
et peut être activée ou désactivée en cliquant sur la case d’activation située près 
du nom de la catégorie.
Â Présentation : contient des commandes de style de paragraphe destinées à contrôler 
la justification, l’alignement et l’interligne. Cette fenêtre contient également des commandes qui permettent de créer un effet « machine à écrire » ou de modifier les 
options de trajectoire de texte. Pour en savoir plus sur l’utilisation des paramètres de 
texte, voir « Utilisation de texte » à la page 615.
Â Masque : affiché uniquement si un masque est sélectionné, cet onglet contient 
le paramètre Adoucissement des bords. Il comporte également des commandes 
vous permettant de modifier le type de forme du masque, de définir les interactions 
entre plusieurs masques (en réglant le paramètre Mode Masque de fusion), ainsi 
qu’une case à cocher Inverser le masque et des curseurs de valeur pour ajuster 
la position des points de contrôle du masque. Pour en savoir plus sur l’utilisation 
des paramètres des masques, voir « Paramètres de masques » à la page 1177.
Â Forme : affiché uniquement si une couche de forme est sélectionnée, cet onglet 
contient toutes les commandes nécessaires pour modifier une forme. Il est divisé 
en quatre fenêtres : Style, Trait, Avancé et Géométrie.
Â Style : contient des commandes servant à modifier le remplissage et le contour 
d’une forme, en changeant notamment le type de pinceau pour un contour 
ou un trait de peinture particulier.
Â Trait : dès lors que vous avez créé un trait à l’aide de l’outil Trait de peinture 
ou réglé le type de pinceau sur Aérographe ou Image pour le contour d’une forme, 
la fenêtre Trait à votre disposition. Utilisez les commandes proposées pour définir 
le mode de couleur de trait et l’échelle du pinceau, régler l’opacité, l’espacement, 
la largeur et l’angle sur trait, ainsi que bien d’autres paramètres.
Â Avancé : contient des commandes grâce auxquelles vous pouvez animer les touches 
d’un trait de peinture comme des particules.
Â Géométrie : contient des commandes qui vous permettent de modifier le type 
d’une forme, de la fermer ou de l’ouvrir, ainsi que de régler séparément la position 
de chacun de ses points de contrôle à l’aide de curseurs.
Pour en savoir plus sur l’utilisation des formes, voir « Utilisation des formes 
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Â Émetteur: apparaît lorsqu’un émetteur de particules est sélectionné. Les paramè-
tres affichés dans cet onglet vous permettent de contrôler tous les aspects d’un 
émetteur, de sa forme et son espace (2D ou 3D) à son angle et sa plage d’émission. 
Il donne également accès aux commandes des cellules. Ces commandes modifient 
toutes les cellules des émetteurs dotés de plusieurs cellules. Pour en savoir plus sur 
l’utilisation des particules, voir « Utilisation des particules » à la page 743.
Â Cellule de particule : apparaît lorsqu’une cellule de particule est sélectionnée. Vous ne 
pouvez sélectionner ces cellules que dans l’onglet Couches et la liste de couches de la 
Timeline. Cet onglet contient des attributs tels que la source d’émission, la vitesse, 
l’angle et la couleur. 
Â Réplicateur : apparaît uniquement si un réplicateur est sélectionné. Vous ne pouvez 
sélectionner les réplicateurs que dans l’onglet Couches et la liste de couches de 
la Timeline. Cet onglet contient des attributs tels que la forme du réplicateur, l’espace 
(2D ou 3D), le motif, la taille et les contrôles de la cellule. Pour en savoir plus 
sur l’utilisation des réplicateurs, voir « Utilisation du Réplicateur » à la page 815.
Â Cellule de réplicateur : apparaît lorsqu’une cellule de réplicateur est sélectionnée. 
Vous ne pouvez sélectionner ces cellules que dans l’onglet Couches et la liste 
de couches de la Timeline.
Â Générateurs : affiche les paramètres et les attributs du générateur sélectionné, tels 
que le centre, la taille et l’intensité d’un générateur Lumière parasite. Les paramètres 
répertoriés dépendent du générateur sélectionné. Pour en savoir plus sur les générateurs, voir « Utilisation de générateurs » à la page 1037.
Verrouillage de l’Inspecteur
Par définition, l’Inspecteur est actualisé de manière dynamique en fonction de l’objet 
sélectionné. Cependant, vous pouvez parfois avoir envie de sélectionner un autre objet 
tout en continuant à examiner les paramètres de l’objet actuel. Si vous verrouillez 
l’Inspecteur, il n’est plus actualisé en fonction de votre sélection.
Pour verrouiller l’Inspecteur, procédez de l’une des manières suivantes :
m Cliquez sur le cadenas situé dans l’angle supérieur droit de la zone de Preview 
de l’Inspecteur.
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Pour déverrouiller l’Inspecteur, procédez de l’une des manières suivantes :
m Cliquez sur le cadenas déverrouillé situé dans l’angle supérieur droit de la zone 
de Preview de l’Inspecteur.
m Choisissez Fenêtre > Créer un Inspecteur verrouillé.
Palette
La palette est l’un des outils les plus polyvalents et pratiques fournis par l’interface de 
Motion. Il s’agit d’une fenêtre flottante actualisée de manière dynamique, qui simplifie 
l’accès aux commandes les plus courantes de l’objet sélectionné, quel qu’il soit.
La palette contient également des commandes spéciales pour certains types d’effets, 
tels que les comportements Animation standard et les systèmes de particules. 
Ces commandes uniques permettent de définir plusieurs paramètres simultanément 
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Par exemple, la palette 2D d’un émetteur de particules contient une seule commande qui 
offre une méthode visuelle pour manipuler trois paramètres d’un système de particules, 
à savoir sa Plage d’émission, son Angle d’émission et sa Vitesse. Pour en savoir plus sur les 
commandes disponibles dans la palette, voir les chapitres correspondant aux différents 
objets.
Remarque : il est plus facile de saisir une valeur spécifique pour un paramètre de curseur 
dans les curseurs de valeur de l’Inspecteur. Vous pouvez également cliquer à gauche 
ou à droite du curseur de l’Inspecteur tout en maintenant la touche Option enfoncée, 
afin de réduire ou d’augmenter la valeur de 1. Le fait de cliquer sur le curseur de valeur 
avec la touche Option enfoncée augmente ou diminue la valeur de 0,01.
Affichage des palettes
Si un objet comporte plusieurs effets, vous pouvez rapidement passer en revue les palettes 
de ces différents effets. Une petite flèche pointant vers le bas et située à côté du titre de la 
palette vous indique que d’autres effets sont appliqués à l’objet sélectionné.
Cliquez sur cette flèche pour dérouler un menu local répertoriant toutes les palettes 
disponibles pour l’objet sélectionné.
Remarque : vous pouvez également appuyer sur la touche D pour passer en revue 
toutes les palettes pour l’objet sélectionné.
Si vous avez sélectionné plusieurs objets du même type, une palette combinée portant 
la mention « Sélection multiple » dans sa barre de titre est affichée.
Flèche signalant la disponibilité 
de plusieurs ensembles de commandes 
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Pour passer d’une palette à l’autre pour l’objet sélectionné, procédez de l’une 
des manières suivantes :
m Cliquez sur la flèche vers le bas dans la barre de titre de la palette, puis choisissez 
la palette à afficher dans le menu local.
m Appuyez sur la touche D pour passer d’une palette à la suivante pour l’objet sélectionné. Pour revenir à la précédente, appuyez sur Maj + D.
Les palettes se suivent selon l’ordre d’application des effets.
En règle générale, la palette affiche un sous-ensemble des paramètres disponibles dans 
l’Inspecteur pour l’objet sélectionné. Lorsque vous travaillez dans la palette, vous avez 
la possibilité de passer directement à l’Inspecteur correspondant pour accéder au reste 
de commandes de cet objet. 
Pour accéder directement à l’Inspecteur depuis la palette :
m Cliquez sur l’icône Inspecteur (« i ») située dans l’angle supérieur droit de la palette.
L’Inspecteur est alors ouvert avec l’onglet correspondant aux commandes de la palette 
au premier plan.
Préférences
Les préférences de Motion permettent de personnaliser votre espace de travail, d’adapter 
l’interface à différents types de projets, de définir des préréglages pour les nouveaux projets et d’exporter vos séquences une fois terminées. Il existe sept ensembles différents de 
commandes qui regroupent les divers réglages en catégories. Pour ouvrir les préférences 
Motion, choisissez Motion > Préférences (ou appuyez sur les touches Commande + virgule).
Générales
La fenêtre des préférences Générales contient des réglages qui s’appliquent globalement 
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Démarrage
Cette section vous permet de déterminer ce que Motion doit faire à l’ouverture. 
Choisissez un élément dans le menu local.
Ouvrir le(s) dernier(s) projet(s) : tout projet qui était ouvert au moment de la dernière 
fermeture du projet est rouvert. Cette option favorise la continuité du travail au fil 
des sessions.
Créer un nouveau projet : cette commande ouvre un nouveau projet vide. Si aucun 
préréglage par défaut n’a été choisi, la zone de dialogue de sélection Préréglage 
du projet apparaît au démarrage.
Afficher l’écran de Bienvenue : il s’agit du réglage par défaut. Quatre options vous 
sont présentées au démarrage : Afficher les visites rapides (lien vers les visites rapides 
de l’application sur Internet), Commencer avec le guide d’initiation (lien vers les guides 
d’initiation de l’application sur Internet), Commencer avec un modèle (ouvre le Navigateur 
de modèles) ou Commencer avec un nouveau projet.
Remarque : pour ignorer l’écran de Bienvenue, modifiez les préférences de Motion (ou 
désactivez la case « Afficher l’écran de bienvenue au démarrage » dans l’écran de Bienvenue).
Parcourir les modèles : cette option vous emmène directement au Navigateur 
de modèles. Pour en savoir plus sur l’utilisation des modèles, voir « Création de 
nouveaux projets à partir de modèles » à la page 199.
Interface
Cette section de la fenêtre Générales permet de définir certaines options générales 
liées à l’interface.
Délai menu déroulant : ce réglage détermine le délai écoulé avant l’affichage du menu 
déroulant lorsque l’on fait glisser des éléments dans la Timeline, la mini-Timeline, l’onglet 
Couches ou le Canevas. Le menu déroulant offre des choix supplémentaires pour modifier 
et importer les objets dans le projet.
Afficher les bulles d’aide : cette case active et désactive les bulles d’aide dans toute 
l’application. Les bulles d’aide fournissent des informations telles que les noms 
des éléments et les techniques d’utilisation élémentaires. Elles apparaissent lorsque 
vous placez le pointeur sur un outil ou une commande.
Navigateur et Bibliothèque
Ces réglages ont une incidence sur la manière dont la fenêtre Utilitaire affiche 
le contenu du Navigateur et de la Bibliothèque.
Afficher les dossiers : ce réglage permet de choisir entre l’affichage alphabétique des 
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Afficher les icônes de Preview : cette case active et désactive les icônes de Preview 
dans la fenêtre Utilitaire. Par exemple, lorsqu’elle est activée, la première image 
d’un film QuickTime est affichée. Lorsqu’elle est désactivée, l’icône QuickTime 
du Finder s’affiche.
Remarque : les captures d’écrans illustrant le Manuel de l’utilisateur Motion 
ont été réalisées avec la case « Afficher les icônes de Preview » désactivée dans 
les préférences Motion.
Lire automatiquement les éléments en un seul clic : cette case permet de contrôler 
si la zone de prévisualisation lit automatiquement le contenu de l’élément sélectionné 
dans la pile de fichiers.
Bibliothèque de contenu et modèles
Lors de son installation, Motion vous permet de choisir un autre emplacement pour 
la bibliothèque de contenu, les modèles et les médias d’initiation. Ce réglage permet de 
pointer vers un dossier de votre système ou réseau contenant la bibliothèque de contenu, 
les modèles et les médias d’initiation Motion. Cela permet également à plusieurs utilisateurs d’un réseau de partager un dossier unique centralisé.
Pour définir le chemin d’accès au contenu de Motion :
1 Cliquez sur Choisir (à côté de Chemin de la Bibliothèque).
2 Dans la zone de dialogue qui apparaît, naviguez jusqu’à l’emplacement du contenu, 
puis cliquez sur Choisir.
3 Redémarrez Motion.
Pour réinitialiser le chemin d’accès au contenu de Motion :
m Cliquez sur Réinitialiser (à côté du bouton Choisir).
Modules de tierce partie
Motion peut lire les modules compatibles After Effects. Ce réglage permet de pointer 
vers un dossier de votre disque dur contenant ces modules.
Si la case « Afficher 
les icônes de Preview » 
est désactivée dans les 
préférences Motion, 
les icônes par défaut 
sont affichées.
Si la case « Afficher 
les icônes de Preview » 
est cochée dans les 
préférences Motion, 
les icônes de Preview 
sont affichées.154 Chapitre 1 Premiers contacts avec Motion
Remarque : les filtres FxPlug doivent être en versions binaires universelles afin 
de pouvoir travailler sur des systèmes Macintosh à processeurs Intel.
Pour définir le chemin des modules :
1 Cliquez sur Choisir (à côté de Chemin de recherche).
2 Dans la zone de dialogue qui apparaît, naviguez jusqu’à l’emplacement des modules, 
puis cliquez sur Choisir.
3 Redémarrez Motion.
Pour effacer le chemin des modules :
m Cliquez sur Effacer (à côté du bouton Choisir).
Média
Si la case « Supprimer automatiquement les données inutilisées » est cochée, 
Motion supprime tout média qui n’est pas actuellement utilisé dans votre projet, 
dès lors que vous supprimez un objet du projet (à partir du Canevas, de l’onglet 
Couches ou de la liste de couches de la Timeline). Ce média n’est donc plus affiché 
dans l’onglet Média.
Éditeur d’images clés
Si la case « Verrouiller les images clés dans le temps » est cochée, vous pouvez modifier 
les valeurs des images clés dans l’Éditeur d’images clés, mais vous ne pouvez pas 
les avancer ou les reculer dans le temps. Vous ne pouvez donc pas modifier le contrôle 
du temps de votre animation lorsque vous modifiez des valeurs.
Apparence
Cette fenêtre contient des réglages destinés au contrôle des éléments visuels 
de l’interface Motion.
Palette
La palette est une fenêtre semi-transparente qui flotte au-dessus des autres fenêtres 
présentes à l’écran. Utilisez le curseur Opacité de la fenêtre pour régler l’opacité 
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Preview des vignettes
Les vignettes affichées dans l’onglet Couches constituent des informations très utiles 
sur les objets sélectionnés dans cette fenêtre. Pour les objets partiellement transparents 
(dotés de canaux alpha), il est d’ailleurs possible de régler l’arrière-plan de l’image. 
Choisissez Damier ou Couleur.
Damier : il s’agit du réglage par défaut. Cette option affiche un damier laissant passer 
les pixels transparents.
Couleur : cette option affiche une couleur unie dans les zones contenant des pixels 
transparents.
Pour changer de couleur d’arrière-plan des vignettes :
1 Sélectionnez Couleur dans le menu local Arrière-plan.
2 Cliquez ou cliquez tout en maintenant la touche Contrôle enfoncée sur le cadre 
de couleur situé à côté du menu local, puis choisissez une couleur dans la fenêtre 
Couleurs ou la palette de couleurs locale.
La couleur sélectionnée devient la couleur d’arrière-plan des vignettes.
Timeline
Ce réglage vous permet de choisir le mode d’affichage des barres présentes dans 
la Timeline pour représenter vos objets. Vous avez le choix entre Nom, Nom plus 
vignette et Pellicule.
Nom : seul le nom de l’objet est affiché par les barres dans la Timeline.
Nom plus vignette : il s’agit de l’option par défaut. Les barres dans la Timeline affichent 
une icône représentant la première image de l’objet, suivie du nom de l’objet.
Pellicule : les barres dans la Timeline affichent une série continue d’images. Le nom 
n’est pas affiché. Pour un exemple de ces différents états, voir « Spécification de l’affichage 
des pistes » à la page 362.
Remarque : seules les couches (formes, images, séquences d’images, texte, etc.) 
affichent une vignette ou une série continue d’images. Les objets tels que les caméras, 
les tables lumineuses et les comportements n’affichent aucune vignette.
Barre d’état
La zone située au-dessus du Canevas et sous la barre d’outils constitue la barre d’état. 
Vous pouvez choisir d’afficher trois types d’informations différentes dans cette zone : 
Couleur, Coordonnées et Fréquence d’images. Vous pouvez également choisir parmi 
trois méthodes différentes de représentation des données de couleur.
Couleur : cette option affiche la valeur de couleur du pixel situé sous le pointeur. 
Les couleurs sont affichées dans le format choisi via l’option Affichage des couleurs.156 Chapitre 1 Premiers contacts avec Motion
Coordonnées : cette option affiche les coordonnées X et Y de la position du pointeur.
Fréquence d’images : cette option affiche la fréquence d’images du projet pendant 
la lecture. Rien n’est affiché tant que la lecture du projet n’a pas été lancée.
Affichage des couleurs : faites votre choix parmi trois styles d’affichage des données 
de couleur.
Â RVB : cette option affiche les valeurs rouge, vert, bleu et alpha de chaque pixel, 
dans une plage allant de 0 à 255. La valeur alpha est également affichée.
Â RVB (en pour cent) : cette option affiche les valeurs rouge, vert, bleu et alpha 
de chaque pixel, dans une plage allant de 1 à 100.
Â TSL : cette option décrit la couleur grâce à sa teinte, sa saturation et sa valeur 
(luminosité). La teinte est une valeur comprise entre 1 et 360, alors que la saturation 
et la valeur vont de 1 à 100. La valeur alpha est également affichée dans une plage 
allant de 1 à 100.
Projet
La fenêtre des préférences du Projet permet de définir des options telles que 
le contrôle du temps, l’affichage et la lecture.
Réglages par défaut
Ces commandes déterminent les valeurs par défaut des projets nouvellement créés. 
Pour modifier les réglages d’un projet spécifique, modifiez les réglages correspondants 
dans la zone de dialogue Propriétés du projet (choisissez Édition > Propriétés du projet 
ou appuyez sur Commande + J).
Remarque : ces réglages sont uniquement pris en compte dans les projets créés 
après la modification des préférences. Tout projet actuellement ouvert ne subit 
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Durée du projet : définit la durée par défaut des nouveaux projets. Vous pouvez 
saisir un nombre dans le champ de valeur et choisir des unités (images ou secondes) 
via le menu local.
Couleur d’arrière-plan : détermine la couleur d’arrière-plan pour tous les nouveaux 
projets créés après la modification de la couleur. Cette option ne modifie pas la couleur 
d’arrière-plan du projet en cours. Pour modifier la couleur d’arrière-plan du projet en cours, 
choisissez Édition > Propriétés du projet (ou appuyez sur les touches Commande + J), 
puis utilisez les commandes Couleur d’arrière-plan.
Remarque : pour que la nouvelle couleur d’arrière-plan soit rendue dans la sortie finale, 
vous devez choisir Couleur unie dans le menu local Arrière-plan de l’onglet Générales 
de la zone de dialogue Propriétés du projet (accessible via Commande + J).
Pour changer de couleur d’arrière-plan :
m Cliquez ou cliquez tout en maintenant la touche Contrôle enfoncée sur le cadre de couleur, 
puis choisissez une couleur dans la fenêtre Couleurs ou la palette de couleurs locale.
La couleur sélectionnée devient la couleur d’arrière-plan de tous les projets 
créés ultérieurement.
Contrôle du temps
Ces réglages contrôlent le mode d’affichage des compteurs de temps dans toute 
l’application.
Contrôle du temps en : deux options vous sont proposées :
Â Images : affiche tous les compteurs sous la forme de numéros d’images 
en progression incrémentielle.
Â Timecode : cette option utilise des numéros de timecode à huit chiffres 
pour afficher le temps dans tous les compteurs.
Numérotation des images : cette option permet de choisir si la numérotation 
des images doit commencer à zéro ou à un.
Images et couches
Ces réglages contrôlent la durée, la position et la taille par défaut des images fixes et 
des couches importées, ainsi que des couches créées dans Motion, comme le texte, les 
formes et les masques.
Durée de couche par défaut : vous pouvez spécifier la durée des images fixes, générateurs et autres couches qui n’ont pas de durée propre, de l’une des deux manières 
suivantes :
Â Utiliser la durée du projet : toutes les couches adoptent la durée du projet.
Â Utiliser une durée personnalisée : les couches adoptent la durée définie dans 
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Vous pouvez définir le temps en images ou en secondes.
Créer couches à : lorsque vous faites glisser des couches vers le Canevas, l’onglet 
Couches ou la liste de couches de la Timeline, elles peuvent être ajoutées à votre projet 
à l’emplacement actuel de la tête de lecture ou au niveau de la première image du projet. 
Ce réglage s’applique également aux couches créées dans Motion, comme le texte 
ou les formes.
Grandes images : lors de l’importation de grandes images fixes, définissez cette 
préférence afin d’indiquer à Motion d’importer le fichier à sa taille d’origine, de changer 
la résolution de l’image en fonction de la taille du Canevas, ou de dimensionner l’image 
à la taille du Canevas.
Â Ne rien faire : importe l’image à sa taille d’origine.
Â Adapter au Canevas : importe et dimensionne l’image en fonction de la taille 
du projet, tout en préservant ses proportions.
Â Réduire à la taille du Canevas : ce réglage change la résolution de l’image importée, 
de sorte qu’elle s’adapte à la taille du projet tout en conservant ses proportions.
Remarque : pour en savoir plus sur les différences entre les diverses options Grandes 
images, voir « Utilisation d’images fixes à haute résolution » à la page 228.
Contrôle de la lecture
Ces réglages contrôlent la manière dont Motion lit votre projet.
Mise à jour du contrôle du temps : lorsque la fenêtre Contrôle du temps est visible, 
vous pouvez régler l’affichage afin qu’il suive automatiquement la lecture de votre 
projet. Choisissez l’une des options suivantes dans le menu local :
Â Ne pas mettre à jour : la fenêtre Contrôle du temps n’est pas modifiée pendant 
la lecture (cela permet d’améliorer les performances).
Â Faire défiler page par page : la fenêtre avance dès que la tête de lecture atteint 
les limites de la vue actuelle. La tête de lecture traverse à nouveau l’écran et ainsi 
de suite.
Â Faire défiler en continu : la tête de lecture demeure statique et la fenêtre Contrôle 
du temps défile en arrière-plan.
Si la synchro. audio est perdue : Motion essaie toujours de maintenir la lecture audio 
et vidéo parfaitement synchronisées, mais lorsque le projet est trop complexe 
pour permettre une lecture fluide, il est nécessaire de donner la priorité à l’audio 
ou à la vidéo. Vous pouvez choisir entre Ignorer les images vidéo et Mettre la lecture 
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Limiter la vitesse de lecture à la fréq. d’images du projet : Motion lit votre projet 
aussi vite que possible en fonction de la complexité des effets et de la puissance 
de votre ordinateur. Si cette case est cochée, la vitesse de lecture ne dépasse jamais 
la fréquence d’images de votre projet. En d’autres termes, vous pouvez visionner votre 
projet à la même fréquences d’images que votre film exporté. Si cette case n’est pas 
cochée, la vitesse de lecture n’est limitée que par la puissance de votre processeur 
et vous pouvez visionner votre film à une fréquence d’images beaucoup plus élevée 
que celle du projet.
Audio en boucle pendant le défilement : cochez cette case pour répéter le son 
des images sur lesquelles vous faites glisser la tête de lecture. Si vous ne sélectionnez 
pas cette case, le son n’est lu qu’une seule fois.
Cache
Cette fenêtre contient des réglages permettant de contrôler le cache du projet, l’enregistrement automatique, le cache LiveFont et la resynchronisation du flux optique.
Mémoire et cache
Ce réglage vous permet d’indiquer la quantité de mémoire à allouer au cache du projet.
Cache du projet : permet de spécifier le pourcentage de la mémoire totale que vous 
souhaitez allouer au cache de votre projet. Plus le pourcentage indiqué est important, 
plus Motion dispose de mémoire pour mettre en mémoire cache les images, ce qui se 
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Enregistrement automatique
Ces réglages contrôlent la fréquence selon laquelle les projets sont enregistrés automatiquement, ainsi que l’emplacement des fichiers enregistrés. Les projets enregistrés font 
l’objet d’un horodatage.
Utiliser l’enregistrement automatique : si cette case est cochée, Motion stocke 
les projets enregistrés automatiquement dans l’emplacement spécifié dans 
le paramètre Dossier d’enregistrement automatique.
Enregistrer toutes les : indique la fréquence, en minutes, selon laquelle est projet 
est enregistré.
Garder au maximum : indique le nombre de versions du projet enregistré automatiquement à conserver dans le dossier.
Maximum de : indique le nombre maximal de projets différents enregistrés automatiquement à conserver dans le dossier.
Dossier d’enregistrement automatique : cliquez sur le bouton Choisir pour définir 
l’emplacement d’enregistrement automatique des fichiers. Si besoin est, le bouton Réinitialiser vous permet de restaurer l’emplacement d’enregistrement par défaut. Par défaut, 
le dossier d’enregistrement automatique est situé dans un dossier appelé Motion Documents,dans le dossier Documents de votre répertoire de départ.
Pour stocker dans un emplacement spécifique les projets enregistrés 
automatiquement :
1 Choisissez Motion > Préférences (ou appuyez sur touches Commande + virgule).
2 Cliquez sur Cache.
3 Dans le groupe Enregistrement automatique, activez l’option Utiliser l’enregistrement 
automatique.
Par défaut, le dossier d’enregistrement automatique est situé dans un dossier appelé 
Motion Documents,dans le dossier Documents de votre répertoire de départ.
Pour définir un nouvel emplacement pour l’enregistrement automatique :
m Cliquez sur Choisir, définissez un nouvel emplacement dans la zone de dialogue, 
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Pour rétablir un projet enregistré automatiquement:
1 Choisissez Fichier > Rétablir à partir de l’enregistrement automatique.
La zone de dialogue Rétablir le projet apparaît.
2 Choisissez un projet enregistré à partir du menu local.
Remarque : pour que les commandes Rétablir apparaissent dans le menu Fichier, 
le fichier doit avoir été précédemment enregistré.
Polices LiveFonts
Ces réglages déterminent la manière dont les polices LiveFont sont mises en mémoire 
cache (stockées) par Motion. 
Placer en cache les tailles de police LiveFont intermédiaires : cette case à cocher 
permet d’activer ou de désactiver la mise en mémoire cache des données LiveFont. 
Cette option est activée par défaut, car elle améliore les performances si vous utilisez 
souvent des polices LiveFonts.
Chemin du cache : cliquez sur Choisir pour définir un emplacement personnalisé 
de mise en mémoire cache de vos données LiveFont. Comme cette mémoire cache 
peut atteindre une taille importante, il est recommandé de choisir un disque différent 
de votre disque dur principal.
Supprimer le cache LiveFont : au fil du temps, ce cache peut augmenter pour atteindre 
plusieurs giga-octets d’espace disque. Vous pouvez récupérer cet espace en cliquant 
sur ce bouton afin de supprimer le cache.
Pour définir un nouvel emplacement pour le cache LiveFont :
m Cliquez sur Choisir, définissez un nouvel emplacement dans la zone de dialogue, 
puis cliquez sur Choisir.
Pour supprimer le cache LiveFont :
1 Cliquez sur Supprimer le cache LiveFont. 
Une zone de dialogue vous invite à confirmer la suppression.
2 Cliquez sur Supprimer. Le cache est alors supprimé.162 Chapitre 1 Premiers contacts avec Motion
Resynchronisation du flux optique
Lorsque vous resynchronisez une séquence, Motion doit stocker les fichiers de resynchronisation correspondants. Ce réglage vous permet d’indiquer l’emplacement d’enregistrement des fichiers de resynchronisation. Vous pouvez choisir de stocker ces fichiers 
au même endroit que la séquence source ou sélectionner un autre emplacement.
Dans le dossier avec les données source : cliquez sur ce bouton pour enregistrer 
les fichiers de resynchronisation au même emplacement que votre séquence source.
Dans ce dossier : cliquez sur le bouton Choisir pour définir l’emplacement 
d’enregistrement des fichiers de resynchronisation du flux optique. Par défaut, 
le dossier de flux optique est situé dans le dossier /Utilisateurs/nom d’utilisateur/
Documents/Motion Documents/Retiming Cache Files.
Pour définir un nouvel emplacement pour les fichiers du flux optique :
m Cliquez sur Choisir, définissez un nouvel emplacement dans la zone de dialogue, 
puis cliquez sur Choisir.
Canevas
Cette fenêtre contient les réglages nécessaires pour personnaliser l’affichage du Canevas. 
Toute modification effectuée dans cette fenêtre est immédiatement répercutée sur 
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Arrière-plan
Ce réglage permet de choisir une couleur pour l’arrière-plan de votre Canevas (la couleur 
en dehors des limites du projet). Cette couleur n’est pas exportée avec votre projet. 
Elle vous sert uniquement à identifier plus facilement les couches en couleur et les 
couches transparentes.
Pour changer la couleur d’arrière-plan du Canevas :
m Cliquez ou cliquez tout en maintenant la touche Contrôle enfoncée sur le cadre 
de couleur du Canevas, puis choisissez une couleur dans la fenêtre Couleurs 
ou la palette de couleurs locale.
La couleur sélectionnée devient la couleur d’arrière-plan du Canevas.
Opacité présentation totale : si vous avez sélectionné « Afficher zone de présentation 
totale » dans le menu Présentation, ce réglage contrôle l’opacité d’arrière-plan de la partie 
d’une couche située en dehors des limites du Canevas. Si vous choisissez 100 %, la couche 
est transparente. En revanche, si vous optez pour 0 %, la couche est totalement opaque.
Alignement
Ces réglages contrôlent la couleur et l’affichage de la grille, des règles et des guides 
optionnels qui apparaissent dans le Canevas. Vous avez la possibilité d’activer ou de 
désactiver l’affichage des grilles, guides et règles via le menu Présentation ou le menu 
local du même nom situé dans l’angle supérieur droit de la fenêtre.
Intervalle de la grille : ce curseur définit la largeur de la grille en pixels.
Couleur de la grille : ce cadre de couleur définit la couleur des lignes de la grille.
Couleur de guide : ce cadre de couleur définit la couleur des guides.
Couleur de guide dynamique : ce cadre de couleur définit la couleur des guides 
dynamiques.
Emplacement de la règle : ce menu local définit la position de la règle dans le Canevas. 
Vous avez le choix entre En haut à gauche, En bas à gauche, En haut à droite ou En bas 
à droite.
Zones sécurisées
Les zones sécurisées sont des guides spéciaux, conçus pour éviter de positionner 
des couches dans des zones de l’écran qui risquent de ne pas s’afficher correctement 
sur les écrans de télévision ordinaires. Les couches apparaissant en dehors de la zone 
d’action sécurisée risquent d’être coupées. La zone située hors de la zone de titre sécurisé risque de subir des déformations qui rendront le texte difficile à lire. Vous avez la 
possibilité d’activer ou de désactiver l’affichage des guides des zones sécurisées via le 
menu Présentation ou le menu local du même nom situé dans l’angle supérieur droit 
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Zone d’action sécurisée : définit le pourcentage du Canevas occupé par les guides 
de la zone d’action sécurisée.
Zone de titre sécurisé : définit le pourcentage du Canevas occupé par les guides 
de la zone de titre sécurisé.
Couleur de la zone sécurisée : définit la couleur des guides de la zone sécurisée.
Zone du film
Lors de la production d’un film destiné à la télévision et au cinéma, il peut s’avérer utile 
de visualiser la zone d’image TV qui sera coupée lors de la conversion au format film. Les 
réglages Zone du film permettent d’afficher un guide qui identifie les proportions du format de film sur lequel vous travaillez. Vous avez la possibilité d’activer ou de désactiver 
l’affichage des guides de la zone du film via le menu Présentation ou le menu local du 
même nom situé dans l’angle supérieur droit de la fenêtre.
Proportions : ce menu local permet soit d’attribuer l’une des proportions standard 
à la taille des guides, soit de saisir une valeur personnalisée.
Pour choisir des proportions :
m Choisissez un réglage dans le menu local Proportions.
Pour créer des proportions personnalisées :
m Saisissez un nombre représentant la largeur de l’écran (en fonction d’une hauteur de 1) 
dans le champ de valeur situé à droite du menu local, puis appuyez sur Retour.
L’option Personnaliser est alors automatiquement activée dans le menu local Proportions.
Couleur de la zone du film : définit la couleur des guides de la zone de film.
Magnétisme
Lorsque vous faites glisser des objets sur Canevas, ils s’alignent automatiquement par 
magnétisme aux objets avoisinants. Ce réglage permet de déterminer si cet alignement 
automatique s’effectue sur les points centraux, les bords, voire les points centraux et 
les bords des objets. Vous avez la possibilité d’activer ou de désactiver ce magnétisme 
via le menu Présentation ou en appuyant sur la touche N lorsque le Canevas est activé.
3D
La fenêtre des préférences 3D vous permet de contrôler divers aspects de l’espace 
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Générales
Cette zone vous permet de contrôler la présentation cadre, ainsi que de choisir si vos 
nouveaux groupes doivent être par défaut en 2D ou en 3D.
Cadre d’affichage général : vous permet de contrôler la présentation cadre de sorte 
qu’elle apparaisse lors des transformations seulement, lors de toutes les modifications 
ou à la demande. Vous devez activer la présentation cadre via le menu ou le menu local 
Présentation pour qu’elle puisse être affichée.
Â Pour les transformations : la présentation cadre est affichée lorsque vous modifiez 
les paramètres de transformation d’un objet, comme Position, Rotation ou Échelle.
Â Pour tous les changements : la présentation cadre est affichée lorsque vous apportez 
des modifications spécifiques à un type d’objet, comme le réglage des paramètres 
d’un réplicateur dans la palette ou l’Inspecteur.
Â Manuellement : si vous choisissez cette option, la présentation cadre est toujours 
affichée.
Taille de la présentation du cadre : utilisez ce curseur pour régler la taille du cadre.
Nouveau type de groupe par défaut : utilisez ce menu pour choisir si vos nouveaux 
groupes doivent par défaut être créés en 2D ou en 3D. Si vous choisissez Automatique, 
Motion détermine le type du groupe créé en fonction du projet. Par exemple, si vous 
travaillez sur un projet 3D et que l’option Automatique est activée, les nouveaux groupes 
sont par défaut en 3D. À l’inverse, si vous travaillez sur un projet 2D (sans aucune caméra), 
les groupes sont créés en 2D.
La fenêtre Présentation cadre est 
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Grille 3D
Cette zone vous permet de modifier les réglages de la grille affichée sur l’espace 
de travail 3D de Motion.
Intervalle de la grille 3D : détermine l’intervalle (en pixels) entre les lignes de la grille.
Taille de la grille 3D : fixe la taille de la grille visible. Plus cette valeur est importante, 
plus la grille s’étend sur l’espace de travail.
Couleur primaire de la grille : vous permet de définir la couleur des lignes principales 
de la grille. Ces lignes sont légèrement plus épaisses que les lignes secondaires.
Couleur secondaire de la grille : vous permet de définir la couleur des lignes secondaires 
de la grille (les lignes intercalées entre les lignes principales).
Pour modifier la couleur primaire ou secondaire de la grille 3D :
m Cliquez ou cliquez tout en maintenant la touche Contrôle enfoncée sur le cadre 
de couleur Grille, puis choisissez une couleur dans la fenêtre Couleurs ou la palette 
de couleurs locale.
La couleur sélectionnée devient la couleur des lignes de la grille.
Sortie
La fenêtre des préférences Sortie indique à Motion de rendre le contenu du Canevas 
vers une platine ou un moniteur vidéo connecté à votre ordinateur via un port FireWire 
ou autre.
Vidéo externe
Ces réglages contrôlent la manière dont Motion lit votre projet directement vers 
une platine ou un moniteur vidéo connecté à votre ordinateur.
Sortie vidéo : utilisez ce menu local pour choisir le type de périphérique connecté 
au moniteur. Si l’option sélectionnée n’est pas Aucune, Motion sort une nouvelle image 
vers le moniteur vidéo connecté chaque fois que vous relâchez le bouton de la souris 
(si le Canevas a été modifié). Le menu est réglé sur Aucune dans le cas où aucun moniteur 
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Si vous disposez de deux moniteurs informatiques, l’un peut être utilisé pour afficher 
l’interface Motion et le Finder, tandis que l’autre peut être utilisé comme moniteur 
vidéo dédié à l’aide d’un affichage cinéma comme moniteur externe. Les choix de 
contrôle vidéo externe suivants sont disponibles :
Â Preview Digital Cinema Desktop : la vidéo n’est pas redimensionnée, sauf si elle 
est trop grande pour tenir sur l’écran. Si le signal vidéo est plus grand que l’affichage, 
il est dimensionné afin de tenir sur l’affichage.
Â Avantages : la vidéo conserve toujours les proportions appropriées et n’affiche 
pas de défauts de mise à l’échelle en raison de l’agrandissement.
Â Inconvénients : certains formats, en particulier les formats SD, peuvent sembler 
très petits lorsqu’ils sont affichés sur des écrans informatiques de grande taille.
Â Preview Digital Cinema Desktop - Plein écran : la vidéo est dimensionnée afin 
de s’afficher dans au moins une dimension. Si les proportions du signal vidéo et 
de l’écran informatique ne correspondent pas, la vidéo sur l’affichage est convertie 
au format Letterbox (bandes noires en haut et en bas) ou Pillarbox (bandes noires 
sur les côtés), si nécessaire.
Â Avantages : ce format offre l’image la plus grande possible et permet d’obtenir 
les proportions appropriées.
Â Inconvénients : des défauts de mise à l’échelle peuvent être perceptibles lors 
d’un affichage rapproché.
Â Preview Digital Cinema Desktop – Principal : utilise votre moniteur principal 
comme écran Digital Cinema Desktop. la vidéo est dimensionnée afin de s’afficher 
dans au moins une dimension. 
Â Avantages : ce format offre l’image la plus grande possible et permet d’obtenir 
les proportions appropriées.
Â Inconvénients : des défauts de mise à l’échelle peuvent être perceptibles lors 
d’un affichage rapproché.
Â Preview Digital Cinema Desktop - Brut : ce mode affiche les données vidéo avec 
le minimum de traitement possible. Cela peut s’avérer utile pour les évaluations 
d’ingénierie de l’image. Aucune mise à l’échelle d’aucune sorte n’est effectuée.
Â Avantages : des évaluations plus précises de la qualité vidéo peuvent être effectuées.
Â Inconvénients : inutile pour l’affichage général. Aucune mise à l’échelle, ni aucun 
ajustement des proportions pixel n’est effectué, même lorsque la vidéo est plus 
grande que l’écran.
Remarque : par exemple, une image 720p (1280 x 720) qui s’affiche en mode brut 
sur un moniteur 800 x 600 affiche uniquement 800 x 600 de l’image. 168 Chapitre 1 Premiers contacts avec Motion
Pour afficher la sortie vidéo Motion sur un moniteur informatique relié à votre 
ordinateur : 
1 Choisissez Motion > Préférences.
2 Dans la fenêtre Sortie, choisissez l’une des options d’affichage du menu local Sortie vidéo.
Options : le bouton Options est actif dès qu’un module Sortie vidéo est activé. 
Il n’est pas nécessaire de régler des options pour les moniteurs connectés via FireWire. 
Les options peuvent être appliquées pour les moniteurs connectés via du matériel 
de tierce partie.
Mise à jour durant la lecture : lit le projet sur le moniteur vidéo externe durant la lecture 
du projet dans le Canevas. Cette option réduit les performances de manière significative.
Mise à jour dynamique après la modification du paramètre : envoie une nouvelle 
image vidéo vers le moniteur vidéo externe pendant que vous réglez les paramètres 
(plutôt qu’après avoir relâché le bouton de la souris). Cette option risque de réduire 
significativement les performances.
Sortie vidéo dans Motion
Si vous êtes en train de créer une œuvre destinée à être diffusé sur des écrans de 
télévision (une émission ou des menus DVD par exemple), il est important de visionner 
votre projet Motion sur ce type d’écran avant de le terminer. Bien que vous puissiez 
réaliser un grand nombre de réglages de présentation et de couleur sur l’écran de 
votre ordinateur, vous serez surpris de constater à quel point un écran de télévision 
peut transformer l’apparence de ce que vous avez réalisé.
Premièrement, que ce soit pour le format NTSC (norme télévisuelle américaine 
et japonaise) ou PAL/SECAM (norme européenne), les couleurs seront différentes
de celles qui sont affichées sur votre ordinateur. (Le format NTSC est parfois appelé 
« Never Twice the Same Color », ce qui signifie en anglais « Jamais deux fois la même 
couleur ».) 
De plus, les signaux TV sont entrelacés, ce qui signifie que la résolution verticale 
est divisée en deux et affichée avec une fréquence d’images deux fois plus élevée. 
Pour parler clairement, les fines lignes horizontales présentes dans votre projet 
(telles que les empattements des polices de caractères) risquent de scintiller lors 
du visionnage sur un écran de télévision.
Motion vous permet heureusement de visionner le contenu de votre Canevas directement sur un écran de télévision connecté à votre ordinateur. Vous pouvez connecter 
un moniteur à votre ordinateur soit via un périphérique FireWire tel qu’un caméscope 
ou une platine DV, soit via une carte de capture vidéo de tierce partie. Pour une plus 
grande précision des résultats, il est recommandé d’utiliser un moniteur de qualité 
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Préréglages
La fenêtre de préférences Préréglages contient des préréglages pour les réglages du projet 
et les réglages d’exportation. Elle vous permet de choisir des réglages par défaut ou de 
créer, modifier ou supprimer des réglages. Le préréglage de projet par défaut détermine 
les réglages attribués lors de la création d’un nouveau projet. Vous pouvez modifier 
n’importe lequel de ces réglages en cours de travail en ouvrant la fenêtre Propriétés 
du projet (choisissez Édition > Propriétés du projet ou appuyez sur Commande + J). 
Afficher : ce menu local vous permet de choisir entre modifier des préréglages pour 
de nouveaux projets ou modifier des préréglages d’exportation. 
Liste de préréglages : la liste actuelle des préréglages apparaît sous le menu Afficher. 
La case située à gauche de chaque nom identifie le préréglage par défaut. Cochez une 
case pour sélectionner un autre préréglage. La colonne située à droite indique les préré-
glages verrouillés. Il est impossible de modifier les préréglages verrouillés. Vous pouvez 
dupliquer un préréglage verrouillé et modifier la copie.
Zone Résumé : située à droite de la liste des préréglages, cette zone affiche 
les informations du préréglage sélectionné.
Créer les nouveaux documents avec les paramètres par défaut : lorsque cette case est 
cochée, la création d’un nouveau projet entraîne automatiquement l’utilisation du préré-
glage de projet par défaut. Dans le cas contraire, la création d’un nouveau projet entraîne 
l’ouverture de la zone de dialogue « Sélectionnez le préréglage du projet », où vous pouvez choisir un préréglage pour votre nouveau projet.
Ajouter un préréglage : cliquez sur le bouton Ajouter (+) afin d’afficher la zone de dialogue Éditeur de préréglages du projet et créez un nouveau préréglage.
Supprimer un préréglage : pour supprimer un préréglage, sélectionnez le préréglage 
à supprimer et cliquez sur le bouton Supprimer (–).
Dupliquer : pour dupliquer un préréglage, sélectionnez-le, puis cliquez sur Dupliquer.170 Chapitre 1 Premiers contacts avec Motion
Modification de préréglages
Pour apporter des modifications à un préréglage, cliquez sur le bouton Modifier afin 
d’ouvrir l’Éditeur de préréglages du projet et saisissez les modifications dans cette 
fenêtre. Il est impossible de modifier des préréglages verrouillés. Si vous tentez de 
le faire, une zone de dialogue vous en avertit. Le préréglage que vous aviez sélectionné est alors dupliqué et vos modifications sont appliquées à sa copie.
Pour ouvrir l’Éditeur de préréglages du projet, procédez de l’une des manières 
suivantes :
m Double-cliquez sur un préréglage non verrouillé dans la liste des préréglages.
m Sélectionnez un élément non verrouillé dans la liste des préréglages, puis cliquez 
sur le bouton Modifier.
m Sélectionnez un élément dans la liste des préréglages, cliquez sur Dupliquer, sélectionnez 
la version dupliquée du préréglage, puis cliquez sur le bouton Modifier.
Éditeur de préréglages du projet
La zone de dialogue Éditeur de préréglages du projet vous permet de modifier 
le contenu des préréglages du projet.
Remarque : lorsque vous double-cliquez sur un préréglage par défaut, une zone 
de dialogue vous avertit que le préréglage sélectionné ne peut pas être modifié. 
Cliquez sur OK afin de créer une copie modifiable du préréglage.
Nom : contient le nom du préréglage.
Description : ce champ contient un texte descriptif du préréglage. Ce texte apparaît 
dans la Zone Résumé de la fenêtre des préférences de préréglage. Vous pouvez saisir 
votre propre description dans ce champ.
Largeur et Hauteur : ces champs définissent la taille d’image du préréglage.
Proportions pixel : détermine le rapport largeur/hauteur d’un pixel du préréglage. 
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Ordre de trame : détermine l’ordre de trame de votre projet. Les projets DV utilisent 
généralement l’option Inférieure en 1er.
Fréquence d’images : détermine la fréquence d’images du préréglage. Cliquez sur la flèche 
de la liste pour afficher les fréquences les plus courantes ou tapez votre propre valeur.
Zone de dialogue Options d’exportation
Si vous souhaitez modifier un préréglage d’exportation, choisissez Préréglages d’exportation dans menu local Afficher, puis cliquez sur le bouton Modifier. La zone de dialogue 
Options d’exportation apparaît alors. Apportez toutes les modifications nécessaires 
dans cette fenêtre. Il est impossible de modifier des préréglages verrouillés. Si vous 
tentez de le faire, une zone de dialogue vous en avertit. Le préréglage que vous aviez 
sélectionné est alors dupliqué et vos modifications sont appliquées à sa copie.
Pour ouvrir la zone de dialogue Options d’exportation, procédez de l’une des manières 
suivantes :
m Double-cliquez sur un préréglage non verrouillé dans la liste des préréglages.
m Sélectionnez un élément non verrouillé dans la liste des préréglages, puis cliquez sur 
le bouton Modifier.
m Sélectionnez un élément dans la liste des préréglages, cliquez sur Dupliquer, sélectionnez 
la version dupliquée du préréglage, puis cliquez sur le bouton Modifier.
Nom : ce champ modifiable contient le nom du préréglage.172 Chapitre 1 Premiers contacts avec Motion
Description : contient un texte descriptif du préréglage. Ce texte apparaît dans la Zone 
Résumé de la fenêtre des préférences de préréglage. Vous pouvez saisir votre propre 
description dans ce champ.
Les onglets Vidéo/Audio et Sortie apparaissent en dessous des champs Nom 
et Description. Une zone de résumé située à droite des onglets affiche 
des informations sur les réglages figurant dans ces deux onglets.
Onglet Vidéo/Audio
L’onglet Vidéo/Audio contient deux groupes de commandes : Vidéo et Audio.
Commandes Vidéo
Ce groupe de commandes vous permet de définir les options de sortie vidéo.
Type : vous avez le choix entre Séquence QuickTime, Image fixe ou Séquence d’images.
Remarque : les options audio sont réservées aux séquences QuickTime.
Compresseur : différents compresseurs sont disponibles en fonction du Type choisi.
Qualité : il est possible de définir un niveau de qualité pour certains compresseurs. 
Si la commande est estompée, cela signifie que ce type de compresseur ne propose 
pas des niveaux de qualité variables.
Nº de début : vous pouvez définir un numéro d’image de début pour les séquences 
d’images. Chaque fichier généré dans la séquence d’images reçoit un numéro en 
progression incrémentielle.
Ajouter des espaces : lors de la génération de séquences d’images, le fait de cocher 
la case Ajouter des espaces entraîne l’ajout d’espaces aux noms de fichiers, afin de 
garantir qu’ils seront lus dans le bon ordre par d’autres applications.
Avancé : le bouton Avancé n’est actif que pour les séquences QuickTime. Cliquez sur 
ce bouton pour ouvrir la zone de dialogue des réglages de compression standard. 
Dans la plupart des cas, il n’est pas nécessaire de modifier le contenu de cette zone 
de dialogue.
Commandes Audio
Ce groupe de commandes vous permet de définir les options de sortie audio.
Échantillonnage : définit la fréquence d’échantillonnage audio de votre film exporté. 
Pour des résultats optimaux, veillez à choisir une fréquence d’échantillonnage identique 
à celle de la source audio de votre projet.
Mixage : détermine le mixage de la sortie audio pour votre projet. Utilisez le réglage 
par défaut, Stéréo, ou choisissez 5.1 Surround.
Avancé : le bouton Avancé ouvre la zone de dialogue des Réglages audio standard. 
Dans la plupart des cas, il n’est pas nécessaire de modifier le contenu de cette zone 
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Onglet Sortie
L’onglet Sortie contient les commandes suivantes :
Utiliser les réglages actuels du projet et du Canevas : lorsque cette case est cochée, 
le contenu de cette zone de dialogue est remplacé par les réglages de votre projet 
actuel. Cela permet d’utiliser un préréglage d’exportation dans plusieurs préréglages 
de projet. Lorsque cette option est désactivée, vous pouvez créer des réglages spécifiques 
pour le préréglage exporté. 
Résolution : vous avez trois possibilités : spécifier une taille de sortie relative à la taille 
d’image du projet (Pleine, 1/2, 1/3 ou 1/4), choisir un préréglage ou choisir Personnaliser, 
puis saisir des nombres précis dans les champs Largeur et Hauteur. Évitez les résolutions 
faibles en dehors de projets en version brouillon.
Couleur : choisissez si les éléments exportés doivent inclure uniquement les données 
de couleur, les données de couleur plus le canal alpha (transparence) ou seulement 
celles du canal alpha.
Important : certains types de compresseur ne gèrent pas les canaux alpha.
Prémultiplier alpha : si cette case est cochée, les pixels semi-transparents de votre 
sortie sont mixés avec du noir.
Fréquence d’images : détermine si la sortie de vos projets est exécutée selon le fréquence 
d’images du projet concerné ou selon une autre fréquence d’images indiquée ici.
Caméra : détermine quelle présentation de caméra est utilisée lors de la sortie d’un 
projet 3D. Utilisez le réglage par défaut, Caméra activée, ou choisissez l’une des autres 
caméras de scène.
Remarque : une caméra de scène est une caméra ajoutée par vos soins à un projet, 
contrairement à une présentation de caméra par défaut que vous pouvez choisir dans 
le coin supérieur gauche du Canevas (comme Haut, Droite, Perspective, etc.). Lors de 
l’exportation d’un projet, seule l’utilisation d’une caméra de scène est possible.
Éclairage : si vous cochez cette case, les effets de lumière sont intégrés au rendu 
du projet. À l’inverse, si vous la désactivez, aucun effet de lumière n’apparaît dans 
la sortie finale.
Qualité de rendu : vous donne le choix entre trois qualités de sortie : Brouillon, 
Normale ou Optimale. Plus la qualité est élevée, plus le rendu est long.
Rendu de trames : lorsque cette case est cochée, les trames sont toujours rendues individuellement au moment de la sortie, quel que soit le réglage effectué dans le menu Pré-
sentation du Canevas. Dans le cas contraire, les images sont rendues de manière globale, 
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Flou d’animation : lorsque cette case est cochée, un flou d’animation est appliqué 
aux couches animées, quel que soit le réglage effectué dans le menu Présentation 
du Canevas. Dans le cas contraire, aucun flou d’animation n’est appliqué.
Fusion d’images : lorsque cette case est cochée, une fusion d’images est appliquée 
au rendu des séquences animées. Cette méthode de rendu est plus lente, mais assure 
une lecture sans à-coups.
Profond. de bits en virgule flottante : lors de l’utilisation de l’espace en virgule flottante, 
la désactivation de cette option réduit le rendu à 8 bits. L’utilisation de l’espace en virgule 
flottante augmentant de façon considérable le temps de traitement, la désactivation 
de cette option permet d’accélérer le rendu. Ce réglage n’affecte pas la profondeur 
de bits en virgule flottante dans le Canevas.
Tablette graphique
La fenêtre des préférences de la Tablette graphique contient des réglages relatifs 
au contrôle de Motion à l’aide d’une tablette graphique.
Vous ne pouvez pas activer l’option Tablette graphique dans Motion tant qu’aucune 
tablette n’est connectée à votre ordinateur et que la reconnaissance d’écriture n’est pas 
activée dans les préférences Ink des Préférences Système. Pour votre commodité, vous 
pouvez ouvrir directement les préférences Ink à partir de la fenêtre des préférences de la 
Tablette graphique, en cliquant sur le bouton Ouvrir les Préférences Ink.
Pour en savoir plus sur l’utilisation des tablettes graphiques, voir l’annexe D, 
« Utilisation des gestes avec une tablette graphique », à la page 1325.
Entrée
Ces réglages contrôlent la manière dont Motion distingue les moments où les mouvements de votre stylet doivent être interprétés comme des mouvements de saisie par geste.
Méthode de saisie : permet de choisir entre l’application des réglages de vos Préférences 
Mac OS et des préférences Wacom et l’utilisation de la saisie par gestes uniquement 
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Si vous choisissez d’utiliser un déclencheur, les mouvements du stylet sur la tablette 
sont interprétés comme des mouvements de souris jusqu’à ce que vous appuyiez 
sur l’un des boutons du stylet ou sur une touche de modification. Ces actions indiquent que vous effectuez une saisie par geste. Le fait de relâcher le bouton ou la touche rétablit le mode souris pour le stylet.
Déclencheur : détermine la méthode du déclencheur utilisée : Bouton de stylet 1, 
Bouton de stylet 2 ou la touche Contrôle de votre clavier.
Autoriser les gestes en l’air: permet de déclencher la saisie par geste sans avoir 
à appuyer la pointe du stylet sur la tablette graphique. Cette option n’est disponible 
que si un déclencheur est utilisé pour activer la saisie par geste.
Menus
La barre des menus de Motion donne accès à presque toutes les commandes de 
l’application. De nombreux éléments de menu sont sensibles au contexte, c’est-à-dire 
qu’ils sont estompés lorsque la commande ne peut pas être utilisée en raison de l’état 
de l’application ou de ce qui est sélectionné. Cette section sert de guide de référence 
à tous les menus.
La plupart de ces commandes disposent de raccourcis clavier qui permettent d’obtenir 
le même résultat à partir du clavier. Ces raccourcis sont présentés entre parenthèses 
après la description.
Menu Application
Le premier menu contient des fonctions générales destinées à contrôler l’application, 
modifier les préférences et accéder au site Web d’Apple. Il donne également accès 
aux services proposés par le système.
À propos de Motion : ouvre la fenêtre « À propos de Motion » dans laquelle figurent 
la version de Motion que vous utilisez, des informations d’enregistrement et les mentions 
légales sur les marques déposées.
Préférences : ouvre les préférences Motion. Pour une description détaillée des réglages 
disponibles dans cette fenêtre (accessible via Commande + virgule), voir « Préférences » 
à la page 151.
Commandes : permet d’accéder aux commandes de personnalisation des touches 
de raccourci clavier.
Â Personnaliser : ouvre l’éditeur de commande.
Â Importer : ouvre une zone de dialogue qui vous permet d’importer un ensemble 
personnalisé de raccourcis clavier.
Â Exporter : ouvre une zone de dialogue qui vous permet d’exporter un ensemble 
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Â Ensembles de commandes : vous permet de charger un ensemble personnalisé 
de raccourcis clavier.
Â Ensembles standard : active les raccourcis clavier par défaut.
Remarque : pour en savoir plus sur la personnalisation des raccourcis clavier, 
voir « Personnalisation des raccourcis clavier » à la page 1289.
Émettre un commentaire sur Motion : ouvre une page Web à partir de laquelle 
vous pouvez envoyer à Apple des commentaires sur Motion.
Enregistrer Motion : cette commande vous connecte au site Web d’Apple afin d’enregistrer votre copie de Motion. Les utilisateurs enregistrés reçoivent des informations sur 
les mises à jour, ainsi que d’autres informations utiles.
Services : cet élément de menu système donne accès à des commandes qui concernent 
différentes applications. Veuillez vous référer à l’Aide Mac OS X pour obtenir plus 
d’informations à propos de ce sous-menu.
Masquer Motion : masque toutes les fenêtres Motion. L’application continue à fonctionner 
en arrière-plan. Vous pouvez la ramener au premier plan en cliquant sur l’icône Motion 
dans le Dock (ou en appuyant sur Commande + H).
Masquer les autres : masque les fenêtres de toutes les applications à l’exception 
de Motion (Option + Commande + H). 
Tout afficher : affiche toutes les fenêtres des applications en cours d’exécution.
Quitter Motion : interrompt le fonctionnement de l’application. Si des documents 
sont ouverts, vous êtes invité à les enregistrer (Commande + Q).
Menu Fichier
Ce menu contient des fonctions et des commandes qui traitent les fichiers de votre 
disque associés à Motion.
Nouveau : crée un nouveau document Motion (Commande + N). 
Ouvrir : ouvre une zone de dialogue qui vous permet de choisir le projet Motion 
que vous souhaitez ouvrir (Commande + O).
Ouvrir un modèle : affiche le Navigateur de modèles à partir duquel vous pouvez 
choisir l’un des modèles intégrés (Maj + Commande + O).
Ouvrir récent : ce sous-menu comprend la liste des dix derniers fichiers ouverts. Il vous 
permet d’accéder rapidement aux projets sur lesquels vous avez travaillé récemment. 
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Fermer : ferme la fenêtre sélectionnée. Si cette fenêtre est le Canevas et que vous 
n’avez pas encore enregistré votre projet, Motion vous invite à l’enregistrer avant de 
fermer la fenêtre (Commande + W). Appuyez sur les touches Option + Commande + W 
pour fermer toutes les fenêtres.
Enregistrer : enregistre sur le disque le projet sélectionné dans son état actuel 
(Commande + S). Appuyez sur les touches Option + Commande + S pour enregistrer 
tous les projets ouverts.
Enregistrer sous : enregistre sur le disque le projet sélectionné dans son état actuel, 
mais sous un nouveau nom (Maj + Commande + S). 
Enregistrer comme modèle : enregistre le projet actuel en tant que modèle. 
Pour en savoir plus sur l’utilisation des modèles, voir « Création de nouveaux 
projets à partir de modèles » à la page 199.
Revenir : revient au dernier état enregistré du projet sélectionné. Tout le travail effectué 
depuis le dernier enregistrement est perdu. Soyez prudent si vous utilisez cette 
commande, car elle est irréversible.
Rétablir à partir de l’enregistrement automatique : affiche une zone de dialogue 
dans laquelle vous pouvez choisir un projet enregistré dans le dossier d’enregistrement automatique.
Importer : ouvre la zone de dialogue Importation de fichiers qui vous permet 
de choisir sur le disque le fichier à importer dans votre projet (Commande + I). 
Importer en tant que projet : affiche la zone de dialogue d’importation de fichier en 
tant que projet. Le fichier choisi est automatiquement placé dans le Canevas d’un projet 
nouvellement créé. Si plusieurs éléments sont sélectionnés, ils sont tous placés dans 
le même projet (Maj + Commande + I).
Exporter : affiche la zone de dialogue d’exportation grâce à laquelle vous transférez 
votre projet actuel vers un fichier sur le disque (Commande + E). Pour en savoir plus 
sur les diverses options d’exportation, voir le chapitre 14, « Exportation de projets 
Motion », à la page 1235.
Exporter la sélection : affiche la zone de dialogue d’exportation grâce à laquelle 
vous transférez uniquement l’objet actuellement sélectionné vers un fichier sur le disque 
(Commande + E). Les objets qui ne sont pas sélectionnés ne sont pas exportés. Pour en 
savoir plus sur les diverses options d’exportation, voir le chapitre 14, « Exportation de 
projets Motion », à la page 1235.
Exporter via Compressor : transfère votre projet actuel vers un fichier sur le disque 
à l’aide de Compressor, afin de créer des fichiers MPEG 2, MPEG 4 ou d’autres fichiers 
destinés à une diffusion sur le Web, sur DVD ou par tout autre moyen informatique 
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Reconnecter les médias : lorsqu’une couche de votre projet fait référence à un fichier 
du disque ayant été déplacé ou modifié, cette commande vous permet de rétablir 
le lien qui les unit. Cette commande n’est activée que si une couche ayant perdu son 
fichier de référence est sélectionnée.
Supprimer les données inutilisées : si un fichier de média est importé dans l’onglet 
Média (mais pas dans votre projet), cette commande vous permet de le supprimer 
de votre projet. Cette commande n’est activée que si un objet ayant perdu son fichier 
de référence est sélectionné.
Format d’impression : affiche la zone de dialogue Format d’impression standard 
dans laquelle vous pouvez définir le format et l’orientation du papier pour l’impression 
(Maj + Commande + P).
Imprimer : affiche la zone de dialogue d’impression standard grâce à laquelle 
vous pouvez imprimer le contenu du Canevas (Commande + P).
Menu Édition
Ce menu contient des fonctions courantes comme Annuler, Couper, Copier et Coller, ainsi 
que des commandes permettant de sélectionner et de supprimer des objets, de modifier 
les propriétés du projet et de contrôler le correcteur orthographique de Motion.
Annuler : cette commande est généralement suivie du nom de la dernière commande 
exécutée, comme par exemple Annuler Déplacer ou Annuler Modification de rotation. 
Le choix de cet élément de menu ramène le projet à l’état avant l’exécution de l’opération concernée. Il est possible d’annuler jusqu’à 99 opérations. Si cette commande est 
estompée, vous n’avez pas la possibilité d’annuler (Commande + Z).
Rétablir : cette commande est généralement suivie du nom de la dernière commande 
exécutée, comme par exemple Rétablir Déplacer ou Rétablir Modification de rotation. 
Elle n’est active que si une ou plusieurs opérations ont été annulées. Choisissez cette commande pour exécuter l’opération qui vient juste d’être annulée (Maj + Commande + Z).
Couper : supprime la sélection et la place dans le Presse-papiers afin de pouvoir 
la coller ultérieurement (Commande + X).
Copier : copie la sélection et la place dans le Presse-papiers afin de pouvoir la coller 
ultérieurement (Commande + C).
Coller : ajoute au projet le contenu du Presse-papiers à l’emplacement sélectionné. 
Cette commande n’est pas disponible si le Presse-papiers est vide ou si son contenu 
ne peut être collé sur la sélection actuelle. Il est par exemple impossible de coller 
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Collage spécial : vous donne le choix entre coller le contenu du Presse-papiers dans 
la Timeline active par Insertion (en écartant les couches existantes) ou par Échange 
du contenu avec l’objet sélectionné (Option + Commande + V). Il existe d’autres options 
possibles. Pour en savoir plus, voir « Collage spécial » à la page 381.
Dupliquer : copie de la sélection et l’ajoute immédiatement au projet (Commande + D). 
Supprimer : supprime l’objet sélectionné. Dans la Timeline, cette commande laisse 
un vide à la place de l’objet supprimé (Suppr). 
Supprimer Ripple : supprime l’objet sélectionné et referme le vide créé dans 
la Timeline (Maj + Suppr).
Insérer temps : ajoute un espace vide dans la Timeline. Vous ne pouvez utiliser cette 
commande qu’après avoir sélectionné une plage de temps dans la règle de la Timeline. 
Pour en savoir plus sur les pages de temps, voir « Définition de la plage de lecture » à la 
page 394.
Scinder : divise un objet en deux, chacun disposant de sa propre piste dans la Timeline. 
La scission se produit à l’emplacement de la tête de lecture. Cette commande est 
estompée si aucun objet n’est sélectionné ou si la tête de lecture n’est pas positionnée 
sur l’objet sélectionné.
Tout sélectionner : sélectionne tous les objets du projet (Commande + A).
Tout désélectionner : annule toutes les sélections (Maj + Commande + A).
Envoyer l’audio vers Soundtrack Pro : vous permet d’indiquer où vous souhaitez enregistrer un fichier audio, puis ouvre ce fichier dans Soundtrack Pro (Commande + U).
Propriétés du projet : ouvre la zone de dialogue des Propriétés du projet où vous 
pouvez modifier les réglages du projet actuel (Commande + J). Pour en savoir plus 
sur la zone de dialogue Propriétés du projet, voir « Onglet Générales de la zone de 
dialogue Propriétés du projet » à la page 202. 
Sous-menu Orthographe
Ce sous-menu contient les commandes de correction orthographique. Ces dernières ne 
sont actives que si une portion de texte est sélectionnée. Pour en savoir plus sur l’utilisation 
du correcteur d’orthographe, voir « Ajout de texte avec l’éditeur de texte » à la page 633.
Orthographe : ouvre la zone de dialogue Orthographe grâce à laquelle vous 
pouvez rechercher des fautes d’orthographe dans la couche de texte sélectionnée 
(Commande + deux-points). 
Vérifier l’orthographe : active le correcteur orthographique sur le texte actuellement 
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Vérifier l’orthographe lors de la frappe : cette commande active et désactive 
la correction orthographique automatique. Une coche en regard de l’élément de 
menu signale que la commande est activée. Cette commande ne fonctionne que 
pour du texte situé dans l’éditeur de texte et non pas dans le Canevas.
Caractères spéciaux : cette commande fait partie de Mac OS X. Elle ouvre la fenêtre 
Palette de caractères qui donne accès aux caractères inhabituels tels que les puces, 
les flèches et les symboles des devises. Dans Motion, elle n’est accessible que si vous 
saisissez du texte dans une couche de texte.
Menu Marquer
Ce menu contient des commandes qui vous permettent de déterminer les points 
de départ et de fin de vos objets, d’ajouter des marqueurs à la Timeline, de naviguer 
à travers votre projet et de contrôler l’animation des effets.
Point d’entrée : cette commande possède deux fonctions. Si vous n’avez sélectionné 
aucun objet, elle définit l’image de début de la plage de lecture à l’emplacement actuel 
de la tête de lecture. Dans le cas contraire, elle effectue un Trim sur le point d’entrée 
de cet objet au niveau de la position actuelle de la tête de lecture (I). 
Point de sortie : cette commande possède deux fonctions. Si vous n’avez sélectionné 
aucun objet, elle définit l’image de fin de la plage de lecture à l’emplacement actuel 
de la tête de lecture. Dans le cas contraire, elle effectue un Trim sur le point de sortie 
de cet objet au niveau de la position actuelle de la tête de lecture (O). 
Déplacer le point d’entrée sélectionné : cette commande déplace les objets sélectionnés, 
de telle sorte que leur point d’entrée soit aligné sur l’emplacement actuel de la tête 
de lecture ({). 
Déplacer le point de sortie sélectionné : cette commande déplace les objets sélectionnés, 
de telle sorte que leur point de sortie soit aligné sur l’emplacement actuel de la tête 
de lecture (}). 
Sous-menu Marqueurs
Ce sous-menu contient toutes les commandes nécessaires pour créer, modifier 
et supprimer des marqueurs. Pour en savoir plus sur l’utilisation des marqueurs, 
voir « Ajout de marqueurs » à la page 398.
Ajouter un marqueur : ajoute un marqueur clé à l’image actuelle. Si vous avez sélectionné un objet, un marqueur d’objet est ajouté. Dans le cas contraire, c’est un marqueur de projet qui est ajouté (appuyez sur M ou sur tilde pour ajouter un marqueur 
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Modifier le marqueur : ouvre la zone de dialogue Modifier le marqueur dans laquelle 
vous pouvez définir le nom, la couleur, la durée et le commentaire associé à 
un marqueur. Cette commande n’est activée que si un marqueur est sélectionné 
(Option + Commande + M).
Supprimer le marqueur : supprime le marqueur sélectionné du projet.
Supprimer tous les marqueurs : supprime tous les marqueurs de l’objet sélectionné. 
Si vous n’avez sélectionné aucun objet, cette commande supprime tous les marqueurs 
du projet.
Marquer le point d’entrée de la plage de lecture : définit le point d’entrée de la plage 
sur l’emplacement de la tête de lecture (Option + Command + I).
Marquer le point de sortie de la plage de lecture : définit le point de sortie de 
la plage sur l’emplacement de la tête de lecture (Option + Command + O).
Réinitialiser la plage de lecture : déplace les points d’entrée et de sortie de la plage 
de lecture sur la première et la dernière image du projet (Option + X).
Lecture : lance la lecture du projet (barre d’espace).
Lecture en boucle : active ou désactive la lecture en boucle. Lorsque cette option 
est activée, la lecture est automatiquement répétée à partir du début de la plage 
de lecture, dès que la fin est atteinte (Maj + L).
Enregistrer l’animation : active ou désactive l’enregistrement des images clés. 
Pour en savoir plus sur l’enregistrement d’animation, voir « Animation dans le Canevas » 
à la page 551.
Options d’enregistrement : ouvre la zone de dialogue Options d’enregistrement, à partir 
de laquelle vous pouvez définir la granularité de l’enregistrement des images clés.
Sous-menu Aller à
Ce sous-menu contient toutes les commandes nécessaires pour accéder à une image 
particulière de votre projet. Toutes ces commandes placent votre tête de lecture sur 
une nouvelle position.
Début du projet : place la tête de lecture sur la première image du projet (Début).
Fin du projet : place la tête de lecture sur la dernière image du projet (Fin).
Début de la plage de lecture : place la tête de lecture sur le point d’entrée du projet 
(Maj + Début).
Fin de la plage de lecture : place la tête de lecture sur le point de sortie du projet 
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Image précédente : recule la tête de lecture d’une image (Flèche gauche).
Image suivante : avance la tête de lecture d’une image (Flèche droite).
10 images en arrière : recule la tête de lecture de dix images (Maj + Flèche gauche).
10 images en avant : avance la tête de lecture de dix images (Maj + Flèche droite).
Image clé précédente : déplace la tête de lecture vers l’image clé précédente dans 
le projet (Option + K).
Image clé suivante : déplace la tête de lecture vers l’image clé suivante dans le projet 
(Maj + K).
Marqueur précédent : place la tête de lecture sur le marqueur précédent le plus 
proche dans le temps (Option + Commande + Flèche gauche).
Marqueur suivant : place la tête de lecture sur le marqueur suivant le plus proche 
dans le temps (Option + Commande + Flèche droite). 
Point d’entrée de la sélection : place la tête de lecture sur la première image de l’objet 
sélectionné (Maj + I). 
Point de sortie de la sélection : place la tête de lecture sur la dernière image de l’objet 
sélectionné (Maj + O).
Sous-menu Preview RAM
Ce sous-menu contient toutes les commandes nécessaires pour lire le projet en temps 
réel, en stockant temporairement les images en mémoire tampon. Pour en savoir plus 
sur l’utilisation des fonctions de Preview RAM, voir « Preview RAM » à la page 66.
Plage de lecture : rend la zone située entre les points d’entrée et de sortie du projet 
et stocke les images en mémoire RAM. Une fois les images stockées, la plage de cette 
zone est lue à vitesse normale (Commande + R).
Sélection : rend la plage de temps occupée par les objets sélectionnés et stocke 
les images en mémoire RAM. Une fois les images stockées, la plage de cette zone 
est lue à vitesse normale (Option + Commande + R).
Tout : rend tout le projet et stocke les images en mémoire RAM. Une fois les images 
stockées, cette zone est lue à vitesse normale (Maj + Option + Commande + R).
Effacer le Preview RAM : efface le cache RAM.
Menu Objet
Ce menu contient toutes les commandes nécessaires à la manipulation des objets dans 
Motion, ce qui inclut leur placement dans la hiérarchie des couches et leur alignement 
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Nouveau groupe : ajoute un nouveau groupe vide au projet (Maj + Commande + N).
Nouvelle caméra : ajoute une nouvelle caméra au projet et vous permet d’indiquer 
si vous souhaitez utiliser le mode 2D ou 3D (Option + Commande + C).
Nouvelle table lumineuse : ajoute une nouvelle table lumineuse au projet et vous 
permet d’indiquer si vous souhaitez utiliser le mode 2D ou 3D (Maj + Commande + L).
Nouvelle zone de dépôt : ajoute une nouvelle zone de dépôt au projet. Les zones 
de dépôt vous permettent de remplacer rapidement une séquence d’un projet, 
en déposant directement des plans dans le Canevas. Une zone de dépôt est représentée par un rectangle comportant un cercle dégradé au centre. Le nom de la couche de 
la zone de dépôt apparaît également au centre de cette zone. Tout objet de média 
glissé et déposé dans la région définie par l’objet Zone de dépôt remplace automatiquement la représentation graphique de ladite zone. Lorsque vous faites glisser 
un média au-dessus de la zone de dépôt, une surbrillance apparaît autour de cette 
zone (Maj + Commande + D).
Faire passer au premier plan : déplace l’objet sélectionné au-dessus de toutes 
les autres couches au sein d’un groupe (Commande + }).
Faire passer à l’arrière-plan : déplace l’objet sélectionné en dessous de toutes 
les autres couches au sein d’un groupe (Commande + {).
Avancer d’un plan : remonte d’un niveau l’objet sélectionné dans l’onglet Couches 
(Commande + ]). 
Reculer d’un plan : descend d’un niveau l’objet sélectionné dans l’onglet Couches 
(Commande + [).
Sous-menu Alignement
Ce menu contient toutes les commandes nécessaires à l’alignement et à la répartition 
de plusieurs objets dans le Canevas. Pour en savoir plus sur la disposition des objets 
dans le Canevas, voir « Utilisation des commandes d’alignement d’objets » à la 
page 299.
Aligner les bords droits : aligne le bord droit de tous les objets sélectionnés sur 
le bord le plus à droite de la sélection.
Aligner les bords supérieurs : aligne le bord supérieur de tous les objets sélectionnés 
sur le bord le plus en haut de la sélection.
Aligner les bords inférieurs : aligne le bord inférieur de tous les objets sélectionnés 
sur le bord le plus en bas de la sélection.
Aligner les bords éloignés : en mode 3D, aligne le bord le plus éloigné de chaque 
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Aligner les bords proches : en mode 3D, aligne le bord le plus proche de chaque objet 
sur l’axe Z (profondeur).
Aligner les centres horizontalement : aligne les objets sélectionnés sur leur point 
central (à l’horizontale). 
Aligner les centres verticalement : aligne les objets sélectionnés sur leur point central 
(à la verticale).
Aligner les centres en profondeur : aligne les objets sélectionnés sur leur point 
central Z (en profondeur).
Distribuer les bords gauches : répartit uniformément les objets sélectionnés entre 
les objets le plus à gauche et le plus à droite en fonction de leur bord gauche.
Distribuer les bords droits : répartit uniformément les objets sélectionnés entre 
les objets le plus à gauche et le plus à droite en fonction de leur bord droit.
Distribuer les bords supérieurs : répartit uniformément les objets sélectionnés entre 
les objets le plus haut et le plus bas en fonction de leur bord supérieur.
Distribuer les bords inférieurs : répartit uniformément les objets sélectionnés entre 
les objets le plus haut et le plus bas en fonction de leur bord inférieur.
Distribuer les bords éloignés : répartit uniformément les objets sélectionnés entre 
les points les plus proches de chaque objet.
Distribuer les bords proches : répartit uniformément les objets sélectionnés entre 
les points les plus éloignés de chaque objet.
Distribuer les centres horizontalement : répartit uniformément les objets sélectionnés 
entre les objets le plus à gauche et le plus à droite en fonction de leur point central 
(à l’horizontale).
Distribuer les centres verticalement : répartit uniformément les objets sélectionnés 
entre les objets le plus haut et le plus bas en fonction de leur point central (à la verticale).
Distribuer les centres en profondeur : répartit uniformément les objets sélectionnés 
entre les objets le plus proche et le plus éloigné en fonction de leur point central Z 
(en profondeur).
Grouper : rassemble tous les objets sélectionnés au sein d’un seul groupe 
(Maj + Commande + G).
Dissocier : annule le regroupement ce qui vous permet de manipuler les objets 
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Activer : active ou désactive l’activation d’un objet. Les objets qui ne sont pas activés 
n’apparaissent ni dans le Canevas ni dans la sortie finale. Lorsque l’élément sélectionné 
est activé, une coche apparaît en regard de la commande dans le menu (Contrôle + T).
Solo : l’application de cette commande à un objet masque tous les autres objets 
du projet. Lorsque l’élément sélectionné est mis en solo, une coche apparaît en regard 
de la commande dans le menu (Contrôle + S). Il est impossible de placer une caméra 
ou une lumière en solo.
Remarque : vous pouvez également cliquer sur un objet tout en maintenant la touche 
Contrôle enfoncée dans l’onglet Couches, puis choisir Solo dans le menu contextuel.
Isoler : l’application de cette commande à un objet restaure son orientation d’origine. 
Si vous souhaitez, par exemple, appliquer un masque ou un effet de rotoscope à une 
couche précédemment transformée en 3D, vous pouvez isoler cette couche afin de 
l’afficher dans son orientation d’origine (en 2D et faisant face à l’avant du projet).
Cette commande est uniquement disponible dans les projets contenant une caméra. 
S’il est possible d’isoler un objet, un petit bouton Isoler apparaît dans l’onglet Couches. 
Cliquez dessus pour isoler l’objet en question. Le menu Caméra du Canevas affiche 
alors le nom de l’objet isolé comme étant la présentation actuelle. En revanche, si vous 
cliquez sur le bouton Isoler d’une caméra, vous activez la présentation de cette caméra.
Verrouiller : le verrouillage d’un objet empêche de lui apporter la moindre modification. 
Lorsque l’élément sélectionné est verrouillé, une coche apparaît en regard de la commande dans le menu (Contrôle + L).
Sous-menu Désactiver la lecture solo
Ce sous-menu permet de désactiver la fonction Solo appliquée à un objet. Trois possibilités 
s’offrent à vous : Vidéo seulement (Contrôle + Maj + S), Audio seulement ou Vidéo 
et Audio. Cette commande n’est disponible que si vous avez sélectionné un objet qui 
est actuellement en solo.
Groupe 3D : convertit le groupe sélectionné en groupe 3D. La désélection de cette 
commande permet de restaurer le groupe en mode 2D (Contrôle + D).
Sous-menu Mode de fusion
Ce sous-menu détermine le mode de fusion de la couche sélectionnée. Une couche 
ne peut toutefois comporter qu’un seul mode de fusion à la fois. Une coche placée en 
regard de la commande de menu indique le mode actuel. Pour des exemples des divers 
modes de fusion, voir « Utilisation des modes de fusion » à la page 322.
Ajouter un masque d’image : ajoute un masque à la couche sélectionnée 
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Ajouter une image clé : ajoute une image clé à l’objet actuellement sélectionné. 
Ce menu change en fonction du type d’image clé que vous ajoutez et devient, par exemple, 
Ajouter une image clé Position, Ajouter une image clé Échelle, etc. (Contrôle + K).
Convertir en images clés : cette commande n’est disponible que si vous avez sélectionné un ou plusieurs objets avec des comportements appliqués. Tous les 
comportements sont alors reproduits sous forme d’images clés sur les paramètres 
qu’ils affectent (Commande + K).
Générer les particules : utilise la couche sélectionnée comme cellule source 
d’un nouvel émetteur de particules (E).
Répliquer : réplique la couche sélectionnée (L).
Cloner la couche : crée un clone de la couche ou du groupe actuellement sélectionné. Dans un projet d’animation, il s’avère parfois nécessaire de réutiliser plusieurs 
fois un objet complexe en divers endroits. Même si vous avez la possibilité de dupliquer ou de couper-coller un objet, aucune des modifications apportées par la suite à 
l’original n’est mise à jour dans ses copies. Le suivi de telles manipulations peut vite 
devenir une tâche fastidieuse et difficile. Aussi, au lieu de dupliquer des couches, clonez-les et vous pourrez contrôler toutes les copies en modifiant juste l’original, tout 
en améliorant la lecture de votre projet et les performances de rendu.
Chaque élément cloné est tout d’abord copié, puis appelé « Couche clonée », « Couche 
clonée 1 », etc. Lorsque vous clonez une couche, son clone est placé dans le même 
groupe. En revanche, lorsque vous clonez un groupe, son clone est placé dans un nouveau groupe. Dans la liste de couches, les éléments clonés sont indiqués par une icône 
spéciale de couche ou de groupe cloné.
Pour en savoir plus, voir « Clonage de couches » à la page 315.
Afficher le média source : ouvre l’onglet Média et met en surbrillance l’élément correspondant à la sélection dans le Canevas ou la Timeline. L’Inspecteur est également mis 
à jour pour afficher les propriétés du média source (Maj + F).
Menu Favoris
Le menu Favoris est vide tant que vous ne créez pas d’effets favoris. Une fois que vous 
avez créé des favoris et que vous les avez stockés dans le dossier Menu Favoris via 
l’onglet Bibliothèque, ils apparaissent dans le Menu Favoris, regroupés par type. 
Afficher les éléments du menu Favoris : ouvre la bibliothèque et affiche le dossier 
Menu Favoris.
Couche d’image clonée Groupe 3D clonéChapitre 1 Premiers contacts avec Motion 187
Menu Présentation
Le menu Présentation contient les commandes nécessaires pour contrôler l’interface 
de Motion. La plupart de ces éléments ont un effet sur le Canevas, mais certains d’entre 
eux s’appliquent également à la Timeline et à d’autres fenêtres.
Zoom avant : effectue un zoom avant sur le Canevas (Commande + signe égal). 
Zoom arrière : effectue un zoom arrière sur le Canevas (Commande + tiret).
Sous-menu Niveau de zoom
Outre le réglage d’un niveau de zoom particulier, ce sous-menu vous permet d’effectuer 
automatiquement un zoom avant ou arrière sur le Canevas afin de l’ajuster à la largeur 
de la fenêtre du Canevas (Maj + Z).
Sous-menu Zoom sur le contrôle du temps
Ce sous-menu permet d’effectuer automatiquement un zoom sur le contenu de 
la Timeline.
Sur le projet : effectue un zoom sur la Timeline afin que toute la durée du projet 
remplisse la fenêtre.
Sur la plage de lecture : effectue un zoom sur la Timeline afin que la zone située 
entre les points d’entrée et de sortie du projet remplisse la fenêtre.
Mode plein écran : remplit votre écran avec le Canevas (la fenêtre Contrôle du temps 
et la sous-fenêtre Projet étant masquées). Ce mode vous permet d’effectuer toutes les 
opérations normales du Canevas, y compris la lecture. Pour quitter le mode plein écran, 
choisissez à nouveau l’élément de menu (F8).
Moniteur vidéo : envoie la sortie vers un moniteur vidéo externe (Commande + F1 ou F12).
Respecter les proportions : adapte l’affichage du Canevas pour simuler les pixels non 
carrés des écrans de télévision.
Afficher zone de présentation totale : active ou désactive l’affichage des couches 
situées en partie ou en totalité en dehors des limites du Canevas. Les zones au-delà 
du Canevas sont par défaut affichées en semi-transparence.
Sous-menu Présentation 3D
Dans un projet 3D, ce sous-menu permet d’affecter la présentation à une caméra de scène 
ou d’activer la présentation de caméra par défaut. Une caméra de scène est une caméra 
que vous avez ajoutée à un projet, alors qu’une présentation de caméra par défaut est une 
« vue » intégrée, comme Perspective, Droite ou Haut. Vous disposez des mêmes options 
dans le menu Caméra, situé dans le coin supérieur gauche du Canevas. Pour en savoir plus 
sur les caméras et les présentations, voir « compositing 3D » dans le manuel Motion Supplemental Documentation PDF.188 Chapitre 1 Premiers contacts avec Motion
Remarque : les éléments d’un projet étant des objets 2D (plats), ils ne sont pas visibles 
lorsque vous utilisez les vues orthogonales d’une caméra, sauf si ces éléments sont 
pivotés en 3D (ou que le paramètre Face à la caméra du texte, des particules ou du 
réplicateur est activé dans l’Inspecteur). En effet, les vues orthogonales sont réalisées 
à angle droit par rapport aux éléments (perpendiculairement). Lorsqu’un objet est 
sélectionné, il est représenté par une fine ligne grise dans le Canevas.
Activer : affiche la présentation de la caméra activée.
Perspective : affiche la présentation en perspective. Cette présentation en perspective est 
par défaut une vue depuis le devant de la scène, au centre. Parmi les outils Présentation 3D, 
vous pouvez alors appliquer à la caméra l’outil Balance, Orbite ou Travelling.
Avant : affiche la présentation depuis l’avant. Parmi les outils Présentation 3D, 
vous pouvez alors appliquer à la caméra l’outil Balance, Orbite ou Travelling.
Arrière : affiche la présentation depuis l’arrière (comme si la caméra était placée 
à l’arrière de la scène). Parmi les outils Présentation 3D, vous pouvez alors appliquer 
à la caméra l’outil Balance, Orbite ou Travelling.
Gauche : affiche la présentation depuis la gauche (comme si la caméra était placée 
sur la gauche de la scène). Parmi les outils Présentation 3D, vous pouvez alors appliquer 
à la caméra l’outil Balance, Orbite ou Travelling.
Droite : affiche la présentation depuis la droite (comme si la caméra était placée sur 
la droite de la scène). Parmi les outils Présentation 3D, vous pouvez alors appliquer à 
la caméra l’outil Balance, Orbite ou Travelling.
Haut : affiche la présentation depuis le haut (comme si la caméra était placée au-dessus 
de la scène). Parmi les outils Présentation 3D, vous pouvez alors appliquer à la caméra 
l’outil Balance, Orbite ou Travelling.
Bas : affiche la présentation depuis le bas (comme si la caméra était placée en dessous 
de la scène). Parmi les outils Présentation 3D, vous pouvez alors appliquer à la caméra 
l’outil Balance, Orbite ou Travelling.
Caméra suivante : lorsque le Canevas est activé, permet de changer de présentation 
en passant à la caméra de scène suivante selon l’ordre de l’onglet Couches (Option + C).
Réinitialiser la présentation de la caméra : réinitialise l’orientation par défaut de la 
présentation de la caméra (Option + R).
Sous-menu Canaux
Ce sous-menu contient les réglages nécessaires pour afficher des canaux de couleurs 
ou de transparence individuels dans le Canevas. Les réglages en cours sont signalés 
par une coche placée en regard de l’élément de menu. À l’exception de l’option de 
bascule, ce sous-menu est identique au menu Couleur affiché par la barre d’état.Chapitre 1 Premiers contacts avec Motion 189
Couleur : affiche l’image telle qu’elle apparaît sur un moniteur vidéo. Les couches visibles 
sont affichées en couleurs naturelles et les zones transparentes révèlent la couleur 
d’arrière-plan définie dans la zone de dialogue Propriétés du projet (Commande + J). 
Par défaut, cette couleur est réglée sur noir.
Transparent : affiche la zone d’arrière-plan du Canevas comme si elle était transparente. 
Un motif en damier est affiché par défaut lorsqu’aucune image ne bloque l’arrière-plan. 
Incrustation alpha : affiche l’image en couleurs normales, mais ajoute une surbrillance 
rouge sur les zones transparentes de l’image.
RVB seulement : affiche le mélange normal des canaux rouge, vert et bleu, mais les zones 
transparentes (y compris les zones semi-transparentes) sont traitées comme des zones 
opaques.
Rouge : permet d’afficher seulement le canal rouge dans le Canevas, sous la forme 
d’une plage allant du noir au blanc (Maj + R).
Vert : permet d’afficher seulement le canal vert dans le Canevas, sous la forme 
d’une plage allant du noir au blanc (Maj + G).
Bleu : permet d’afficher seulement le canal bleu dans le Canevas, sous la forme 
d’une plage allant du noir au blanc (Maj + B).
Alpha : permet d’afficher dans le Canevas le canal alpha (transparence) des couches 
qui s’y trouvent (Maj + A).
Alpha inversé : permet d’afficher dans le Canevas une vue inversée du canal alpha 
(transparence) (Option + Maj + A). 
Basculer entre actuel et alpha : permet d’alterner entre l’affichage de l’état actuel 
et l’affichage du canal alpha uniquement (V). 
Sous-menu Résolution
Ce sous-menu définit le niveau de qualité du Canevas. Une réduction de la résolution 
améliore les performances de lecture. Vous avez le choix entre Pleine, 1/2, 1/3 et 1/4. 
Chaque réglage de niveau inférieur entraîne une dégradation de l’image. Une coche 
placée en regard de la commande de menu indique l’état actuel.
Qualité de rendu : définit le mode d’affichage des objets, tels que le texte et les images, 
dans le Canevas. Vous avez le choix entre : Brouillon, Normale ou Optimale.
Â Brouillon : exécute un rendu de faible qualité des objets dans le Canevas, afin d’assurer 
une interactivité optimale à votre projet.
Â Normale : réglage par défaut. Exécute un rendu de qualité moyenne des objets 
dans le Canevas.
Â Optimale : exécute un rendu d’excellente qualité des objets dans le Canevas. 
Cette option ralentit l’interactivité de votre projet.
Remarque : dans le Canevas, les fichiers YUV à 10 bits sont rendus à 8 bits, à moins 
que la Qualité de rendu ne soit réglée sur Optimale.190 Chapitre 1 Premiers contacts avec Motion
∏ Astuce : si vous cochez la case « Séquence - Utiliser les réglages du projet et du Canevas 
actuels » lors de l’exportation d’un projet (dans le menu local Utiliser de la zone 
de dialogue d’exportation), réglez Qualité de rendu sur Optimale avant de procéder 
à l’exportation.
Éclairage : désactive les effets de lumière pour améliorer les performances. 
Lorsque cette option est activée, une coche apparaît en regard de son nom 
dans le menu (Option + L). 
Rendu de trames : désactive le rendu de trames pour améliorer les performances. 
Lorsque cette option est activée, une coche apparaît en regard de son nom dans 
le menu (Option + F). 
Flou d’animation : désactive le rendu du flou d’animation pour améliorer les performances. Lorsque cette option est activée, une coche apparaît en regard de son nom 
dans le menu (Option + M). 
Fusion d’images : désactive la fusion d’images pour améliorer les performances. 
Lorsque cette option est activée, une coche apparaît en regard de son nom dans 
le menu (Contrôle + Option + B). 
Preview de la profondeur de bits en virgule flottante : lors de l’utilisation de l’espace 
en virgule flottante, la désactivation de cette option passe à 8 bits le Preview dans 
le Canevas. Étant donné que l’utilisation de l’espace en virgule flottante augmente 
de façon considérable le temps de traitement, la désactivation de ce paramètre permet 
d’accélérer les opérations. Cette option ne modifie pas le projet final proprement dit.
Remarque : dans le Canevas, les fichiers YUV à 10 bits sont rendus à 8 bits, à moins 
que la Qualité de rendu ne soit réglée sur Optimale.
Afficher les incrustations : active ou désactive l’affichage de toutes les incrustations sur 
le Canevas. Ce réglage doit être activé pour visualiser un élément incrusté quelconque 
(grille, guide, etc.). Lorsque cette option est activée, une coche apparaît en regard 
de son nom dans le menu (Commande + /).
Afficher les règles : active ou désactive l’affichage des règles dans le Canevas. 
Lorsque cette option est activée, une coche apparaît en regard de son nom dans 
le menu (Maj + Commande + R).
Sous-menu Incrustations
Ce sous-menu active et désactive l’affichage des différents indicateurs, guides et grilles 
du Canevas.
Grille : active ou désactive l’affichage d’une grille. Vous pouvez d’ailleurs personnaliser 
cette grille via la fenêtre Canevas des préférences Motion. Lorsque cette option est activée, 
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Guides : active ou désactive l’affichage de guides. Lorsque cette option est activée, 
une coche apparaît en regard de son nom dans le menu (Commande + point-virgule). 
Guides dynamiques : active ou désactive les guides dynamiques. Les guides dynamiques 
sont les lignes qui s’affichent lorsque vous faites glisser un élément pour l’aligner sur 
une autre couche. Lorsque cette option est activée, une coche apparaît en regard 
de son nom dans le menu (Maj + Commande + point-virgule).
Remarque : appuyez sur la touche N pour rapidement activer ou désactiver les guides 
dynamiques.
Zones sécurisées : active ou désactive l’affichage des guides des zones de titre et 
d’action sécurisées. Vous pouvez personnaliser les zones sécurisées via la fenêtre Canevas 
des Préférences Motion. Lorsque cette option est activée, une coche apparaît en regard 
de son nom dans le menu (apostrophe). 
Zone du film : active ou désactive l’affichage des guides de la zone du film (en fonction 
des limites de formats). Vous pouvez personnaliser les zones de film via la fenêtre 
Canevas des Préférences Motion. Lorsque cette option est activée, une coche apparaît 
en regard de son nom dans le menu (Maj + apostrophe). 
Poignées : active ou désactive l’affichage des poignées des objets dans le Canevas. 
Les poignées sont en fait les points situés dans les coins d’un objet et qui vous permettent 
de le manipuler. Lorsque les poignées sont affichées, une coche apparaît en regard 
de l’élément de menu.
Lignes : active ou désactive l’affichage des bordures des objets. Lorsque les lignes sont 
affichées, une coche apparaît en regard de l’élément de menu.
Trajectoire d’animation : active ou désactive l’affichage des trajectoires d’animation 
avec images clés. Les trajectoires d’animation sont des lignes qui vous indiquent 
le chemin emprunté par un objet dans le Canevas. Lorsque les trajectoires d’animation 
sont affichées, une coche apparaît en regard de l’élément de menu.
Sous-menu Guides
Ce sous-menu permet de contrôler les guides dans le Canevas.
Verrouiller les guides : verrouille tous les guides sur leur position actuelle. Ainsi, vous 
ne pouvez pas déplacer accidentellement un guide en essayant de déplacer un objet 
(Option + Commande + point-virgule).
Déverrouiller les guides : libère les guides afin de pouvoir les manipuler manuellement.
Effacer les guides : supprime tous les guides du Canevas.
Ajouter un guide vertical : ajoute un guide vertical au Canevas.
Ajouter un guide horizontal : ajoute un guide horizontal au Canevas.192 Chapitre 1 Premiers contacts avec Motion
Magnétisme : active ou désactive le magnétisme des objets dans le Canevas. 
Le magnétisme aligne automatiquement les objets au fur et à mesure que vous 
les faites glisser. Lorsque le Magnétisme est activé, une coche apparaît en regard 
de l’élément de menu (N). 
Afficher les incrustations 3D : active ou désactive toutes les incrustations 3D, y compris 
celles des outils Présentation 3D, Boussole 3D, Présentation cadre, Grille 3D et des Icônes 
scène 3D.
Sous-menu Incrustations 3D
Outils Présentation 3D: active et désactive le menu Caméra ainsi que les outils 
Présentation 3D.
Boussole : active et désactive l’outil Boussole 3D. La boussole vous indique votre 
orientation actuelle dans l’espace 3D. L’axe X (horizontal) est rouge, l’axe Y (vertical) 
vert et l’axe Z (profondeur) bleu.
Si vous positionnez le pointeur sur la boussole, il se transforme en sélecteur d’affichage 3D. 
Cliquez sur l’une des icônes de couleur (Avant, Gauche, Droite, Perspective, etc.) 
pour afficher la présentation correspondante. Le Canevas s’anime alors en fonction 
de la nouvelle présentation sélectionnée.
Présentation cadre : active ou désactive la présentation cadre. Lorsque cette option 
est activée, une fenêtre temporaire apparaît dans le coin inférieur droit du Canevas. 
Elle affiche la vue de la caméra activée ou la vue en perspective de votre projet, ce qui 
vous aide à vous orienter au fil du déplacement d’objets dans l’espace 3D. Vous pouvez 
modifier sa taille et indiquer si vous souhaitez qu’elle apparaisse lors des transformations 
seulement, lors de toutes les modifications ou à la demande.
Grille 3D : active ou désactive l’affichage de la grille 3D. Cette grille 3D vous aide à vous 
orienter en espace tridimensionnel et peut servir de guide lors du positionnement 
d’objets dans votre projet. Elle n’apparaît que si vous travaillez en mode 3D.
Icônes scène 3D : active ou désactive l’affichage des icônes scène 3D, telles que les 
lumières et les caméras. Ces icônes apparaissent sur le Canevas comme des éléments 
en fil de fer. Chacune comporte des poignées rouge, verte et bleue qui vous permettent 
de transformer et faire pivoter la caméra ou la lumière correspondante.
Afficher/Masquer les polices : affiche (ou masque) la zone de dialogue qui permet 
de sélectionner des polices et leurs attributs (Commande + T).
Afficher/Masquer les couleurs : affiche (ou masque) la fenêtre Couleurs qui permet 
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Afficher/Masquer la barre d’outils : affiche ou masque la barre d’outils, ce qui revient 
à cliquer sur le bouton Barre d’outils situé dans l’angle supérieur droit du Canevas 
(Option + Commande + T).
Personnaliser la barre d’outils : ouvre la zone de dialogue Personnaliser la barre 
d’outils.
Menu Fenêtre
Ce menu contient les commandes nécessaires pour afficher et masquer tous les onglets 
et les fenêtres de l’interface de Motion. Il vous permet également de choisir et de gérer 
des ensembles de présentations de fenêtre.
Placer dans le Dock : réduit la fenêtre active et la place dans le Dock, ce qui revient 
à cliquer sur le bouton Placer dans le Dock qui se trouve dans l’angle supérieur gauche 
de la fenêtre (Commande + M).
Zoom : redimensionne la fenêtre active afin de maximiser l’espace disponible sur 
le bureau. Elle permet d’alterner entre le mode plein écran et l’état d’écran normal 
enregistré précédemment.
Enregistrer la présentation actuelle : enregistre la disposition de fenêtres actuelle. 
Pour utiliser cette option, vous devez nommer la présentation à enregistrer. Elle apparaît 
ensuite dans le sous-menu Présentations.
Gérer les présentations : ouvre la zone de dialogue Gérer les présentations grâce 
à laquelle vous pouvez ajouter, supprimer, dupliquer et modifier des présentations 
de fenêtres personnalisées.
Sous-menu Présentations
Vous pouvez choisir parmi les présentations de fenêtres existantes dans ce sous-menu. 
Choisissez l’une des présentations proposées dans le sous-menu pour disposer 
les fenêtres selon le préréglage sélectionné. Pour en savoir plus sur la gestion 
des présentations, voir « Présentation des fenêtres » à la page 25.
Créer un Inspecteur verrouillé : crée une fenêtre Inspecteur qui n’est pas mise à jour 
en fonction de la sélection. Pour déverrouiller l’Inspecteur, cliquez sur le cadenas situé 
dans la zone de Preview de l’Inspecteur.
Sous-menu Afficher l’Inspecteur
Ce sous-menu vous offre un accès direct à l’un ou l’autre des quatre onglets de la fenêtre 
Inspecteur : Propriétés (F1), Comportements (F2), Filtres (F3) et Objet (F4). L’onglet Objet 
varie en fonction du type d’objet sélectionné. 
Afficher/Masquer la fenêtre du projet : affiche ou masque la sous-fenêtre Projet (F5). 
Afficher/Masquer le Contrôle du temps : affiche ou masque la fenêtre Contrôle 
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Afficher/Masquer la palette : affiche ou masque la palette (F7).
Afficher/Masquer la liste des tâches : la liste des tâches d’arrière-plan répertorie tous 
les traitements en cours à l’arrière-plan lorsque Motion exécute des resynchronisations 
du flux optique.
Navigateur : affiche ou masque le Navigateur. Si la fenêtre Utilitaire n’est pas présente, 
l’application en crée une. Lorsqu’elle ne comporte que l’onglet Navigateur, cette commande ferme la fenêtre (Commande + 1).
Bibliothèque : affiche ou masque la Bibliothèque. Si la fenêtre Utilitaire n’est pas présente, 
l’application en crée une. Lorsqu’elle ne comporte que l’onglet Bibliothèque, cette 
commande ferme la fenêtre (Commande + 2).
Inspecteur : affiche ou masque l’Inspecteur. Si la fenêtre Utilitaire n’est pas présente, 
l’application en crée une. Lorsqu’elle ne comporte que l’onglet Inspecteur, cette 
commande ferme la fenêtre (Commande + 3).
Couches : affiche ou masque l’onglet Couches. Si la sous-fenêtre du projet n’est pas 
visible, cette commande l’ouvre. Lorsqu’elle ne comporte que l’onglet Couches, cette 
commande ferme la sous-fenêtre (Commande + 4).
Média : affiche ou masque l’onglet Média. Si la sous-fenêtre du projet n’est pas visible, 
cette commande l’ouvre. Lorsqu’elle ne comporte que l’onglet Média, cette commande 
ferme la sous-fenêtre (Commande + 5).
Audio : affiche ou masque l’onglet Audio. Si la sous-fenêtre Projet n’est pas visible, 
cette commande l’ouvre. Lorsqu’elle ne comporte que l’onglet Audio, cette commande 
ferme la sous-fenêtre (Commande + 6).
Timeline : affiche ou masque la Timeline. Si la fenêtre Contrôle du temps n’est pas 
visible, cette commande l’ouvre. Lorsqu’elle ne comporte que l’onglet Timeline, 
cette commande ferme la fenêtre (Commande + 7).
Éditeur d’images clés : affiche ou masque l’Éditeur d’images clés. Si la fenêtre Contrôle du temps n’est pas visible, cette commande l’ouvre. Lorsqu’elle ne comporte que 
l’onglet Éditeur d’images clés, cette commande ferme la fenêtre (Commande + 8).Chapitre 1 Premiers contacts avec Motion 195
Éditeur audio : affiche ou masque l’Éditeur audio. Si la fenêtre Contrôle du temps 
n’est pas visible, cette commande l’ouvre. Lorsqu’elle ne comporte que l’onglet Éditeur 
audio, cette commande ferme la fenêtre (Commande + 9). 
Tout ramener au premier plan : si l’une des fenêtres de Motion se trouve masquée 
derrière des fenêtres d’autres applications, cette commande la ramène au premier plan.
Liste des projets ouverts : tous les projets ouverts sont affichés en bas du menu Fenêtre. 
Le choix d’un élément de cette liste amène le Canevas de ce projet au premier plan.
Menu Aide
Le menu Aide permet l’accès aux ressources permettant d’en savoir plus sur Motion.
Manuel de l’utilisateur Motion : ouvre une version PDF du Manuel de l’utilisateur Motion.
Notes sur la version : ouvre une page web contenant d’éventuelles modifications 
de dernière minute apportées à Motion, ainsi qu’à la documentation et susceptibles 
d’affecter l’utilisation du logiciel.
Nouvelles fonctionnalités : ouvre le document Nouvelles fonctionnalités au format PDF.
Assistance Motion : ouvre une page Web qui contient des informations actualisées 
d’assistance technique concernant Motion.
Motion sur le Web : ouvre un lien Internet vers la communauté Motion en ligne 
d’Apple. Ce site contient des guides d’initiation, des ressources relatives à la formation, 
des informations sur les mises à jour et d’autres renseignements très utiles.
Centres de formation Apple : ouvre un lien vers la page Web du centre de formation 
Apple, où vous trouverez des informations sur les centres de formation Apple agréés 
de votre secteur. 
Émettre un commentaire : ce lien vous permet d’accéder directement à la page 
des commentaires relatifs à Motion. Vous pouvez ainsi communiquer à Apple un point 
de vue précieux, des suggestions et des commentaires sur votre expérience lors 
de l’utilisation de Motion.
Créer un profil de gestion : génère un fichier spécial contenant les détails techniques 
de votre station de travail, notamment la vitesse du processeur, les spécifications de 
la carte vidéo, etc. Ce fichier est utilisé uniquement par des techniciens agréés Apple. 2
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Apprenez à créer, enregistrer et gérer vos fichiers de projet. 
Vous verrez également comment différents types d’objets 
peuvent être rassemblés au sein d’un projet afin de créer 
une composition.
Un fichier de projet constitue une composition unique sur laquelle vous travaillez. 
Les fichiers de projet contiennent des objets, qui sont en fait des références associées 
aux fichiers de médias sources stockés sur disque, mais ils ne contiennent pas les 
médias eux-mêmes. Les fichiers de projet ne font que rassembler des informations sur 
la manière dont les compositions sont assemblées, l’identité des fichiers de médias utilisés et l’identité des effets de la Bibliothèque qui ont été appliqués. Ils comprennent 
également les formes, les masques et les objets texte que vous créez.
Création de projets
Avant de pouvoir faire quoi que ce soit dans Motion, vous devez d’abord créer un nouveau projet. Il existe pour cela trois manières de procéder, en fonction du type de projet 
adopté. Vous pouvez créer votre composition en vous inspirant de l’un des modèles proposés, créer un nouveau projet vierge à l’aide de l’un des préréglages de projet disponibles 
ou créer un nouveau projet à l’aide de vos réglages personnalisés s’il vous faut, par exemple, une dimension ou une fréquence d’image inhabituelle.
Motion est une application indépendante du point de vue de la résolution d’image ; 
elle prend en charge toutes sortes de projets présentant un large éventail de dimensions 
et de fréquences d’images. Motion permet de créer de petits films destinés à la diffusion 
sur le Web, des films à haute définition ou à définition standard pour la télédiffusion 
ou même des fichiers de qualité cinématographique destinés à être transférés sur pellicule. Motion fonctionne toujours de la même manière quel que soit le niveau de résolution adopté. Les projets à haute résolution impliquant des fichiers de données de grande 
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Important : Motion n’est pas indépendant du matériel. Autrement dit, le type de carte 
graphique installé sur votre système régit les performances et la taille maximale des 
fichiers que vous pouvez importer dans Motion. Pour la plupart des cartes recommandées, 
la limite de taille des fichiers est de 2 Mo. Pour en savoir plus à ce sujet, visitez le site 
web de Motion à l’adresse suivante : http://www.apple.com/fr/finalcutstudio/motion.
Chaque projet possède un groupe de propriétés de projet unique qui définit la durée 
du projet, les dimensions du Canevas, la fréquence d’images en lecture et d’autres 
caractéristiques ayant une incidence sur la manière dont votre composition est formatée. 
Une fois le projet terminé, vous pourrez, lors de la phase d’exportation du projet, sélectionner des propriétés de projet pour définir le fichier de médias à créer. Bien que vous 
puissiez à tout moment modifier ces réglages, il est recommandé de choisir des réglages 
adaptés au format de sortie final souhaité. 
Quels que soient vos réglages de projet, Motion peut ajouter à votre projet pratiquement 
n’importe quel type de fichier de médias compatible avec QuickTime. Vous êtes en 
outre libre de mélanger des fichiers de médias dotés de propriétés différentes dans 
le même projet. Vous pouvez par exemple combiner des plans vidéo présentant 
différentes dimensions d’image avec des fichiers graphiques. Votre fichier final utilisera 
les dimensions et la fréquence d’image spécifiées par les propriétés du projet.
À l’ouverture initiale de Motion
La première fois que vous lancez Motion, un écran de Bienvenue vous propose deux 
méthodes de création d’un nouveau projet. Vous pouvez cliquer sur « Commencer 
avec un modèle » pour ouvrir le Navigateur de modèles ou sur « Commencer avec 
un nouveau projet » pour créer un fichier de projet vierge. 
Par défaut, cet écran s’affiche toujours à l’ouverture de Motion. Pour éviter l’affichage 
de cet écran, décochez la case « Afficher l’écran de Bienvenue au démarrage » située en 
bas ou choisissez une autre option de démarrage dans le menu local Au démarrage de 
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Ouvrir le(s) dernier(s) projet(s) : ouvre automatiquement le dernier projet sur lequel 
vous avez travaillé chaque fois que Motion est ouvert.
Créer un nouveau projet : ouvre la zone de dialogue Sélectionnez le préréglage 
du projet, afin que vous puissiez sélectionner un préréglage à utiliser pour créer 
un nouveau projet vierge. Si vous avez sélectionné un préréglage de projet par 
défaut, cette zone de dialogue n’apparaît pas.
Afficher l’écran de Bienvenue : affiche l’écran de Bienvenue à chaque ouverture 
de Motion.
Parcourir les modèles : ouvre le Navigateur de modèles, afin que vous puissiez 
sélectionner un modèle.
Pour en savoir plus sur les options disponibles dans les préférences Motion, 
lisez la rubrique « Préférences » à la page 151.
Création de nouveaux projets à partir de modèles
La méthode la plus simple pour créer un projet dans Motion consiste à ouvrir l’un 
des modèles et de le personnaliser en fonction de vos besoins. Les modèles de Motion 
ne sont rien d’autre que des projets prédéfinis, disponibles via le Navigateur de modèles, 
et configurés pour permettre une personnalisation aisée. Motion est fourni avec tout 
un éventail de modèles libres de droit que vous pouvez utiliser et personnaliser à votre 
guise. Chaque modèle contient des éléments graphiques, des objets texte et des images 
d’arrière-plan prédéfinis que vous pouvez utiliser tels quels ou remplacer par vos objets 
personnalisés afin de créer une œuvre personnelle. 
Vous pouvez étendre cette collection en créant vos propres modèles de maquettes 
fréquemment utilisées. Si vous créez régulièrement des titres et des séquences graphiques pour une série télévisée par exemple, vous pouvez créer pour l’émission un groupe 
de modèles contenant les maquettes de tous les plans d’animation graphique nécessaires. Il suffit ensuite d’ouvrir ces modèles et de les personnaliser avec du texte et des animations graphiques actualisés, sans avoir à créer de nouveau chaque maquette en 
partant de zéro.
Les modèles fournis avec Motion sont disponibles en résolutions NTSC, PAL et HD. 
Tous les modèles sont classés par thèmes.
Pour créer un nouveau projet à partir d’un modèle :
1 Pour ouvrir le Navigateur de modèles, procédez de l’une des manières suivantes :
Â À l’ouverture de l’écran de Bienvenue de Motion, cliquez sur « Commencer avec 
un modèle ».
Â Si Motion est déjà ouvert, choisissez Fichier > Ouvrir un modèle (ou appuyez sur 
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2 Lorsque le Navigateur de modèles apparaît, utilisez le menu local Afficher pour parcourir 
les modèles optimisés pour un format vidéo spécifique, notamment NTSC, PAL ou HD. 
Vous pouvez également choisir d’afficher Tous les formats ou Autres formats.
La liste des thèmes répertorie tous les modèles du type sélectionné.
3 Cliquez sur un thème de modèles pour en afficher son à droite.
4 Cliquez sur un modèle pour en afficher un aperçu dans la zone de Preview, ainsi que des 
informations supplémentaires incluant la résolution, la durée et la fréquence d’images.
5 Pour créer un nouveau projet à partir du modèle sélectionné, cliquez sur Ouvrir un modèle.
Un nouveau projet est créé avec les objets inclus dans ce modèle. Vous pouvez ensuite 
le personnaliser en modifiant ses objets texte ou en remplaçant ses éléments graphiques 
par les vôtres. Les modifications que vous apportez aux projets créés à l’aide de modèles 
ne sont pas enregistrées dans le fichier de modèle source.
Pour en savoir plus sur l’utilisation, la modification et la création de modèles, lisez 
la rubrique « Personnalisation et création de nouveaux modèles » à la page 278.
Menu local Afficher
Zone de Preview
Emplacement 
des propriétés 
du projet
Emplacement 
de la description 
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Création de projets vierges à partir de préréglages de projet
Si vous êtes en train de créer en partant de zéro un nouveau projet dont le résultat final 
devra être conforme à l’une des normes standard habituelles de diffusion sur le Web, 
de télédiffusion ou de transfert sur pellicule cinématographique, vous pouvez utiliser 
l’un des préréglages de projet fournis avec Motion. Contrairement à l’utilisation d’un 
modèle, le choix d’un préréglage ne définit que les propriétés essentielles du projet, 
telles que les dimensions et la fréquence d’image. Le projet résultant est complètement 
vierge, prêt à recevoir vos propres objets.
Comme vous pouvez ouvrir dans Motion autant de fichiers de projet que le permet 
la quantité de RAM prise en charge par votre ordinateur, vous pouvez à tout moment 
créer un nouveau projet sans avoir à fermer les projets ouverts.
Pour créer un nouveau projet :
1 Choisissez Fichier > Nouveau (ou appuyez sur les touches Commande + N).
2 Choisissez un préréglage dans le menu local, puis cliquez sur OK.
Une nouvelle fenêtre de projet est créée. Elle n’est pas enregistrée sur disque tant que 
vous n’avez pas choisi une commande d’enregistrement dans le menu Fichier. Pour en 
savoir plus sur l’enregistrement des fichiers de projet, lisez la rubrique « Enregistrement 
des projets » à la page 210.
Remarque : si vous avez défini un préréglage par défaut, Motion ouvre une nouvelle 
fenêtre de projet à cette résolution, contournant ainsi la zone de dialogue Sélectionnez 
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Création de projets vierges à l’aide de réglages personnalisés
Si aucun des préréglages proposés ne répond à vos besoins, vous pouvez créer 
un nouveau projet à l’aide de réglages personnalisés à partir de la même fenêtre.
Pour créer un nouveau projet à l’aide de réglages de projet personnalisés :
1 Choisissez Fichier > Nouveau (ou appuyez sur les touches Commande + N).
Remarque : si vous avez déjà défini un préréglage par défaut, maintenez enfoncée 
la touche Option et choisissez Fichier > Nouveau à partir du préréglage (ou appuyez 
sur les touches Option + Commande + N).
2 Choisissez Personnaliser en bas du menu local Préréglage, puis cliquez sur OK.
La zone de dialogue Propriétés du projet s’ouvre.
3 Choisissez les réglages appropriés sous les onglets Générales et Réglages de rendu, 
puis cliquez sur OK.
Une nouvelle fenêtre de projet est créée à l’aide des réglages spécifiés.
Onglet Générales de la zone de dialogue Propriétés du projet
L’onglet Générales permet de définir les propriétés les plus essentielles du projet que 
vous êtes en train de créer. En choisissant différents paramètres, vous pouvez adapter 
votre projet à presque tous les formats vidéo ou de film nécessaires. Ces propriétés 
constituent les réglages par défaut utilisés lorsque vous exportez votre projet afin 
de créer le fichier de sortie final. 
L’onglet Générales met à votre disposition les réglages suivants :
Préréglage : le menu local Préréglage se trouve en haut de l’onglet Générales. 
Vous pouvez choisir un préréglage existant comme base pour votre nouveau 
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Largeur et Hauteur : détermine à la fois la taille du Canevas et la résolution de sortie 
par défaut de votre projet. Les dimensions de l’image sont généralement définies par 
le format vidéo vers lequel vous envisagez de faire le transfert. Ainsi, le format vidéo 
NTSC DV correspond à 720 x 480, alors que le format vidéo PAL DV correspond 
à 720 x 576.
Profondeur de bits : définit la profondeur de bits du projet sur l’une des valeurs suivantes :
Â 8 bits (entier)
Â 16 bits en virgule flottante
Â 32 bits virgule flottante
Remarque : lors de l’utilisation d’un espace en virgule flottante, vous pouvez rapidement 
convertir l’aperçu affiché dans le Canevas en 8 bits, afin d’accélérer le flux de travaux. 
Il suffit de désactiver l’option « Preview de la profondeur de couleur en virgule flottante » 
dans le menu local Présentation. Le menu local Présentation se trouve dans l’angle 
supérieur droit de la fenêtre principale (sous l’icône Contrôle du temps). Cette option 
ne modifie pas le projet final proprement dit.
À propos de la profondeur de bits
Si vous utilisez des images, l’augmentation du nombre de bits par pixel de ces images 
implique la disponibilité d’un plus grand nombre d’informations sur les couleurs. 
Une image bitmap à un bit par pixel est constituée exclusivement de pixels noirs 
ou blancs (pas de niveaux de gris). 
Une image en niveaux de gris contient des pixels avec 256 niveaux de gris. Chaque pixel 
nécessite 8 bits pour représenter les 256 niveaux de gris. Par conséquent, la profondeur 
de bits d’une image en niveaux de gris est égale à 8 (28 = 256).
Une image RVB peut comporter des pixels avec 256 niveaux de chacune des couleurs 
primaires (rouge, vert et bleu). Dans ce cas, il existe 28 (256) nuances de chaque composante de couleur. Il en résulte plus de 16,7 millions de couleurs possibles (256 x 256 x 256 
> 16,7 millions). La profondeur de bits d’une image RVB peut être de 24 (8 bits pour 
chaque couleur), et celle d’une image RVBA (rouge, vert, bleu et un canal alpha) peut être 
de 32 (8 bits pour chaque couleur + canal alpha). La profondeur de bits d’un canal alpha 
décrit la transparence de chaque pixel. Bien que ces images comportent 24 et 32 bits, de 
telles images couleur sont souvent appelées images 8 bits (en raison des 8 bits par canal).
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Le réglage de la profondeur de bits dans Motion est en bits par canal. Dans un projet 
Motion à 8 bits, les 256 niveaux de couleur sont représentés sur une échelle de nombres 
entiers allant de 0 à 255 (où 0 représente le noir et 255 représente le blanc). Toutes vos 
opérations sont limitées à cette plage de 0 à 255. Chaque nombre correspond alors à 
une seule couleur et inversement. En mode 8 bits, il est donc possible de représenter 
16,7 millions de couleurs, ce qui correspond au nombre de combinaisons possibles 
entre les 256 valeurs de couleur différentes de chacun des canaux Rouge, Vert et Bleu. 
Bien que ce nombre de couleurs semble élevé, il est souvent utile de disposer de gradations de couleur plus précises. Grâce aux calculs en virgule flottante, les tons peuvent 
se subdiviser en un nombre gigantesque de couleurs intermédiaires, offrant une multitude de couleurs disponibles dans la palette de votre projet. Le mode 16 bits en virgule 
flottante assure évidemment davantage de couleurs intermédiaires, sans pour autant 
égaler le mode 32 bits en virgule flottante qui est encore plus précis.
La profondeur de bits de votre métrage source détermine souvent la profondeur de bits 
de votre projet. Même si votre métrage source est en mode 8 bits, vous pouvez être 
amené à travailler dans un projet avec une profondeur de bits supérieure afin d’obtenir 
de meilleurs résultats. Lorsque vous augmentez la profondeur de bits de votre projet, 
vous n’introduisez pas de nouvelles informations de couleur dans les images originales. 
En revanche, les opérations telles que les incrustations, la correction de couleur, l’application de flou ou d’autres filtres avec des valeurs de paramètre élevées, ou la création 
de graphiques nécessitant des dégradés de couleur très progressifs, peuvent tirer parti 
du nouveau nombre de niveaux de couleur possibles.
Important : l’utilisation de profondeurs de bits supérieures a cependant un coût. Ce coût 
se traduit en temps de traitement. Rappelez-vous également que, étant donné que Motion 
n’est pas indépendant du matériel, la plupart des systèmes présentent une limitation quant 
à la taille des fichiers importés. Pour en savoir plus sur le matériel requis, consultez le site 
Web de Motion à l’adresse suivante : http://www.apple.com/fr/finalcutstudio/motion.
Lorsque vous exportez un projet 16 ou 32 bits en virgule flottante, n’oubliez pas que la 
plupart des formats de fichiers proposés pour l’exportation ne prennent pas en charge 
la virgule flottante, y compris QuickTime (8 bits seulement). OpenEXR est un format en 
virgule flottante. Les fichiers TIFF, PNG et Adobe Photoshop prennent en charge le format 
16 bits Integer.
Remarque : selon votre projet, la diffusion peut être soit utile, soit problématique. 
Par exemple, l’activation de la diffusion dans un projet présentant un effet de bande 
peut réduire l’apparence de celui-ci. Dans un projet en virgule flottante, la diffusion 
peut provoquer un excès de bruit à la sortie du projet. C’est la raison pour laquelle 
une case à cocher a été ajoutée à la zone de dialogue Propriétés du projet (choisissez 
Édition > Propriétés du projet ou appuyez sur les touches Commande + J) pour vous 
permettre d’activer ou de désactiver la diffusion. Ce réglage s’applique à l’affichage 
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Proportions pixel : détermine si le projet a été créé à l’aide de pixels carrés ou non carrés. 
Les écrans d’ordinateur, les films et la vidéo à haute définition utilisent des pixels carrés, 
tandis que la vidéo à définition standard utilise des pixels non carrés. Choisissez soit 
Carré pour les projets destinés au Web, les projets à haute définition et les films, soit 
l’un des formats non carrés correspondant à chaque norme de diffusion à définition 
standard. Un champ situé à droite de ce menu local affiche les valeurs de proportions 
pixel afin que vous puissiez éventuellement les modifier manuellement.
Ordre de trame : lorsque vous travaillez avec de la vidéo entrelacée, choisissez dans 
ce menu local l’ordre de trame que vous comptez utiliser pour la sortie. Cet ordre doit 
correspondre à l’ordre de trame du périphérique utilisé pour transférer le fichier de 
sortie QuickTime final sur vidéo. Choisissez Aucune si vous travaillez avec de la vidéo 
à balayage progressif ou un format de film.
Fréquence d’images : choisissez une fréquence d’images (en images par secondes) correspondant au format vers lequel vous effectuerez la sortie finale. Pour les films, cette fré-
quence est de 24 ips ; pour la vidéo PAL, elle est de 25 ips et pour la vidéo NTSC de 29,97 
ips. D’autres fréquences d’images sont disponibles pour différents formats vidéo.
Durée : cette option permet de saisir la durée totale disponible dans la Timeline 
de votre projet. Un menu local permet de définir la durée soit en valeur de timecode, 
en fonction de la fréquence d’images sélectionnée, soit en nombre d’images ou en 
secondes. La valeur par défaut est de 900 images ou 30 secondes.
Timecode début : cette valeur détermine le timecode de début pour l’affichage lorsque 
vous travaillez dans un projet.
Couleur d’arrière-plan : cadre de couleurs vous permettant de déterminer la couleur 
affichée dans le Canevas si aucun autre graphisme ou objet QuickTime n’est présent.
Arrière-plan : menu local qui définit si le rendu de la couleur d’arrière-plan doit être 
effectué comme une partie du canal alpha. Si vous choisissez Uni, la couleur d’arrière-plan 
génère un canal alpha opaque. En revanche, si vous choisissez Transparent, le rendu de 
la couleur d’arrière-plan n’est pas obtenu comme une partie du canal alpha. Quel que 
soit votre choix, la couleur d’arrière-plan est affichée dans le Canevas.
Description du projet : vous pouvez saisir une brève description du projet dans ce champ. 
Il s’avère également utile pour signaler les caractéristiques distinctives du préréglage, 
telles que les dimensions ou la fréquence d’images.
Pour en savoir plus sur les dimensions de l’image, les fréquences d’images, l’entrelacement 
et d’autres réglages de projet couramment utilisés, lisez la rubrique « Formats vidéo et 
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Onglet Réglages de rendu de la zone de dialogue Propriétés du projet
L’onglet Réglages de rendu contient des paramètres qui ont une incidence sur la manière 
dont Motion effectue le rendu des objets et de l’animation de votre projet. Ces réglages 
peuvent avoir une incidence sur l’aspect de votre projet lorsqu’il est exporté.
Flou d’animation : simule l’effet provoqué par l’obturateur mécanique d’une caméra 
qui enregistre un sujet en mouvement sur film ou vidéo. Dans Motion, le flou d’animation 
a un effet sur les objets de votre projet qui sont animés à l’aide de comportements 
ou d’images animées. Cela vous permet de créer un mouvement d’aspect plus naturel 
dans votre projet, même si l’animation est créée artificiellement. Comme c’est le cas 
lorsque l’on filme à l’aide d’une caméra, les objets plus rapides sont davantage affectés 
par le flou tandis que les objets plus lents le sont moins. 
Important : contrairement à Final Cut Express HD ou Final Cut Pro, le flou créé par 
ces paramètres n’a aucun effet sur le mouvement qui se produit dans un fichier 
de séquence QuickTime ou une séquence d’images. Il n’a une incidence que sur 
les objets animés.
La section Flou d’animation possède deux paramètres :
Â Échantillons : nombre de sous-images rendues par image, où une image correspond 
à 360 degrés. Les valeurs élevées créent un flou d’animation de meilleure qualité, 
mais exigent une plus grande puissance de traitement pour le processeur. La valeur 
Échantillons par défaut est de 8. La valeur maximale possible est de 256.
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L’image suivante affiche une forme qui a été incrustée pour un déplacement rapide 
et horizontal sur le Canevas.
Dans l’image suivante, le flou Motion est activé et la valeur Échantillons est définie sur 8.
Remarque : lorsque vous utilisez des valeurs d’angle d’obturateur plus élevées, 
il peut s’avérer nécessaire d’augmenter le nombre d’échantillons afin d’éliminer 
les artefacts indésirables.
Â Angle d’obturateur : définit la taille du flou d’animation appliqué aux objets animés. 
L’augmentation de l’angle d’obturateur augmente le nombre d’images sur lesquelles 
l’obturateur est ouvert.
Dans l’image ci-dessus, l’angle d’obturateur est défini sur 360 degrés (valeur par défaut), 
qui représente une image. Dans l’image suivante, l’angle d’obturateur est défini 
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Création, modification et suppression de préréglages
Si vous créez généralement des projets à l’aide de réglages personnalisés ne correspondant à aucun des préréglages disponibles, vous pouvez créer un nouveau préréglage 
comprenant ces réglages afin de les utiliser ultérieurement. Les opérations de création, 
de modification et de suppression de préréglages s’effectuent dans la fenêtre Préréglages des préférences Motion.
Pour créer un nouveau préréglage personnalisé :
1 Choisissez Motion > Préférences (ou appuyez sur touches Commande + virgule).
2 Dans la sous-fenêtre Préréglages, choisissez Préréglages du projet dans le menu 
local Afficher.
3 Cliquez sur le bouton Ajouter (+) situé sous la liste des préréglages. 
La zone de dialogue Éditeur de préréglages du projet s’ouvre.
4 Dans la zone de dialogue Éditeur de préréglages du projet, procédez comme suit :
Â Dans le champ Nom, tapez un nom décrivant le préréglage.
Â Tapez une brève description de l’usage de ce préréglage. Il peut également s’avérer 
utile de signaler les caractéristiques distinctives de ce préréglage, telles que 
les dimensions et la fréquence d’images.
Â Tapez les dimensions de l’image dans les champs Largeur et Hauteur.Chapitre 2 Création et gestion de projets 209
Â Choisissez des Proportions pixel, un Ordre de trame et une Fréquence d’images 
dans les menus locaux correspondants.
5 Cliquez sur OK.
6 Une fois que vous avez terminé de créer de nouveaux préréglages de projet, 
fermez la fenêtre des préférences Motion.
Remarque : pour en savoir plus sur les normes standard de dimensions d’image, 
de proportions pixel, d’ordre de trame et de fréquence d’images, lisez la rubrique 
« Formats vidéo et de fichiers » à la page 1293.
Pour faire d’un préréglage personnalisé le nouveau préréglage par défaut, 
procédez de l’une des manières suivantes :
m Dans la fenêtre Préréglages des préférences Motion, cochez la case située à gauche 
du préréglage destiné à devenir le préréglage par défaut pour tous les nouveaux 
projets créés.
m Choisissez Fichier > Nouveau afin d’afficher la zone de dialogue Sélectionnez 
le préréglage du projet. Choisissez un préréglage de projet dans le menu local 
Préréglage, puis cliquez sur Par défaut.
Vous pouvez également modifier des préréglages existants. Cela vous permet de mettre 
à jour un préréglage que vous avez créé ou d’en créer un nouveau en personnalisant 
un préréglage existant doté de réglages similaires.
Pour dupliquer un préréglage existant avant de le modifier:
1 Dans les préférences Motion, sélectionnez un préréglage dans la fenêtre Préréglages.
2 Cliquez sur Dupliquer. 
Le préréglage dupliqué apparaît sous le préréglage d’origine.
Pour modifier un préréglage :
1 Dans les préférences Motion, sélectionnez un préréglage dans la fenêtre Préréglages.
2 Cliquez sur Modifier.
3 Lorsque la zone de dialogue Éditeur de préréglages du projet apparaît, effectuez 
les modifications nécessaires, puis cliquez sur OK.
Remarque : vous ne pouvez pas modifier ou supprimer des préréglages de projet 
verrouillés.
Pour supprimer un préréglage personnalisé :
1 Dans les préférences Motion, sélectionnez un préréglage dans la fenêtre Préréglages.
2 Cliquez sur le bouton Supprimer (–) situé sous la liste des préréglages.
Remarque : vous ne pouvez pas déverrouiller un préréglage intégré à Motion. 
Lorsque vous double-cliquez sur un préréglage de ce type, un avertissement vous 
indique que le préréglage sélectionné ne peut pas être modifié. Pour créer une copie 
de ce préréglage en vue de la personnaliser, cliquez sur OK.210 Chapitre 2 Création et gestion de projets
Transfert de préréglages entre ordinateurs
Chaque préréglage créé est enregistré en tant que fichier séparé. Si vous avez créé 
un ou plusieurs préréglages personnalisés qui vous sont utiles et que vous utilisez 
Motion sur d’autres ordinateurs, il sera peut-être nécessaire de transférer ces préréglages 
personnalisés sur ces ordinateurs. Tous les préréglages personnalisés sont stockés 
dans le dossier /Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/
Final Cut Studio/Motion/Presets/Projectde votre ordinateur.
Pour copier un préréglage de projet vers un autre ordinateur:
m Copiez vos fichiers de préréglages personnalisés dans le dossier /Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/Motion/Presets/Project de 
cet autre ordinateur.
Gestion des projets
L’organisation est un élément important lorsque vous travaillez sur un projet dans 
Motion. Cela implique d’effectuer un suivi scrupuleux de vos fichiers de projet, d’enregistrer fréquemment votre travail en cours et de procéder à des sauvegardes réguliè-
res. L’idée essentielle consiste à veiller à ce que rien ne soit accidentellement supprimé 
ou mal placé et que vous ne perdiez pas votre travail en égarant vos précieuses ressources numériques. Motion enregistre donc automatiquement les projets, afin de pouvoir les récupérer à tout moment.
Enregistrement des projets
Comme c’est le cas avec n’importe quelle autre application, il est recommandé d’enregistrer votre travail dès le départ et fréquemment au fur et à mesure de son évolution. 
Vous éviterez de cette manière toute perte due à des événements imprévus tels 
qu’une panne de courant généralisée qui surviendrait juste au moment où vous êtes 
sur le point de terminer votre dernier chef d’œuvre d’animation.
Outre le fait de préserver votre travail en vue d’y revenir plus tard, les commandes d’enregistrement de Motion peuvent être utilisées d’autres manières pour gérer le développement de votre projet. Si vous êtes, par exemple, content de votre composition actuelle 
mais que vous souhaitez créer une variante du travail accompli, vous pouvez utiliser la 
commande Enregistrer sous pour enregistrer une copie du projet actuel. Vous pourrez 
ensuite modifier cette copie et garder le projet original intact afin de pouvoir y revenir si 
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La commande Enregistrer sous peut également servir d’outil d’archivage car elle permet d’enregistrer régulièrement des copies distinctes de votre projet tout au long de 
sa création. Cela permet d’atteindre deux objectifs. Premièrement, vous possédez 
des copies de votre fichier de projet, ce qui vous évite d’égarer par inadvertance 
votre seule copie et de perdre ainsi des journées entières de travail. Deuxièmement, 
vous disposez également d’un moyen de revenir à des versions antérieures de votre 
composition si jamais il est nécessaire de procéder à des modifications en fonction 
d’un état antérieur du développement de ce projet.
Pour enregistrer un projet :
1 Choisissez Fichier > Enregistrer (ou appuyez sur les touches Commande + S).
Si le projet n’a pas encore été enregistré, la zone de dialogue Enregistrer sous apparaît.
2 Tapez un nom dans le champ Enregistrer sous, choisissez un emplacement sur 
votre disque dur afin d’y enregistrer le fichier, puis cliquez sur Enregistrer. 
Remarque : si le projet a déjà été enregistré, le fichier de projet est simplement mis 
à jour.
Pour enregistrer une copie d’un projet :
1 Choisissez Fichier > Enregistrer sous (ou appuyez sur les touches Maj + Commande + S).
La zone de dialogue Enregistrer sous apparaît. 
2 Tapez un nouveau nom dans le champ Enregistrer sous, choisissez un emplacement 
sur votre disque dur, puis cliquez sur Enregistrer.
Important : si vous utilisez la commande Enregistrer sous, il est important de choisir 
un nom différent des versions déjà enregistrées du même projet, car vous risquez, 
dans le cas contraire, d’écraser une version antérieure de ce fichier de projet. Dans ce cas, 
un message d’avertissement s’affiche.
Pour enregistrer tous les projets ouverts :
1 Appuyez sur la touche Option, puis choisissez Fichier > Tout enregistrer (ou appuyez 
sur les touches Commande + Option + S).
2 Si tous les fichiers de projet ouverts ont été enregistrés, la commande Tout enregistrer 
ne fait que les mettre à jour. Si l’un des projets ouverts n’a jamais été enregistré, tapez 
un nom dans son champ Enregistrer sous, puis cliquez sur Enregistrer.212 Chapitre 2 Création et gestion de projets
Remarque : la commande Tout enregistrer n’apparaît que si vous appuyez sur la touche 
Option en ouvrant le menu Fichier.
Recueil des données
Lors de l’enregistrement d’un projet, Motion vous offre la possibilité de regrouper automatiquement tous les médias utilisés dans ce projet. Les données correspondantes sont 
alors recueillies dans un dossier de votre choix. Ce recueil présente l’avantage de faciliter 
la portabilité et les copies de sauvegarde, ainsi que de pouvoir organiser tous les médias 
de votre projet à un seul emplacement. Par défaut, l’option Recueil données est désactivée.
Pour utiliser la fonction d’enregistrement Recueil données :
1 Choisissez Fichier > Enregistrer sous (ou appuyez sur les touches Commande + Maj + S). 
La zone de dialogue Enregistrer sous apparaît. 
2 Choisissez « Copier dans le dossier » dans le menu local Recueil données.
Sélectionnez l’option « Copier dans le dossier » pour créer un dossier dont vous précisez 
le nom dans le champ Enregistrer sous. Un fichier de projet Motion portant le même 
nom est créé dans ce dossier, ainsi qu’un dossier appelé « Média » contenant tous les 
médias utilisés dans ce projet.
Si vous activez l’option Recueil données, vous avez la possibilité d’indiquer si vous 
souhaitez également collecter les médias inutilisés. 
Utilisation de l’enregistrement automatique
Motion enregistre automatiquement des sauvegardes de votre projet dans un dossier 
sur votre disque dur. Dans la sous-fenêtre Projet des préférences Motion, vous pouvez 
spécifier la fréquence d’enregistrement automatique des projets, ainsi que l’emplacement 
des fichiers enregistrés. L’heure et la date d’enregistrement du projet sont spécifiées.
Utiliser l’enregistrement automatique : indique à Motion de stocker les projets 
enregistrés automatiquement à l’emplacement spécifié dans le paramètre Dossier 
d’enregistrement automatique.
Enregistrer toutes les : indique la fréquence, en minutes, selon laquelle est projet 
est enregistré.
Garder au maximum : indique à Motion le nombre de versions du projet enregistré 
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Maximum de : indique à Motion le nombre maximum de projets différents enregistrés 
automatiquement à conserver dans le dossier.
Pour stocker à un emplacement spécifique les projets enregistrés 
automatiquement :
1 Choisissez Motion > Préférences (ou appuyez sur touches Commande + virgule).
2 Cliquez sur Projet.
3 Dans le groupe Enregistrement automatique, activez l’option Utiliser l’enregistrement 
automatique.
Par défaut, le dossier d’enregistrement automatique se trouve dans un dossier nommé 
Projets Motion dans le dossier Documents de votre répertoire de départ.
Pour définir un nouvel emplacement pour l’enregistrement automatique :
m Cliquez sur Choisir, puis sélectionnez un nouvel emplacement dans la zone de dialogue 
qui apparaît.
Pour revenir à un projet enregistré automatiquement:
1 Choisissez Fichier > Rétablir à partir de l’enregistrement automatique.
La zone de dialogue Rétablir le projet apparaît.
2 Choisissez un projet enregistré à partir du menu local.
Utilisation de la commande Revenir dans les projets
La commande Revenir annule toutes les modifications apportées à un projet depuis 
son dernier enregistrement. Cette commande est particulièrement utile pour essayer 
diverses modifications sur votre projet. Vous pouvez enregistrer votre projet dans l’état 
qui vous convient, puis essayer toutes les modifications souhaitées. Si le résultat ne vous 
plaît pas, utilisez la commande Revenir pour revenir immédiatement à l’état antérieur.
Remarque : vous pouvez également utiliser la fonction d’annulation illimitée de Motion 
pour obtenir le même résultat par incréments. Pour en savoir plus sur la commande 
Annuler, lisez la rubrique « Menu Édition » à la page 178.
Pour rétablir la dernière version enregistrée d’un projet :
m Choisissez Fichier > Revenir.214 Chapitre 2 Création et gestion de projets
Ouverture et fermeture de projets
Vous pouvez ouvrir un ou plusieurs fichiers de projet enregistrés antérieurement soit 
à partir du Finder, soit à partir de Motion. Le nombre maximal de projets ouverts simultanément dépend de la quantité maximale de mémoire RAM prise en charge par votre 
ordinateur. La mémoire RAM de votre ordinateur est répartie entre le système d’exploitation, les applications en cours d’exécution et tous les projets ouverts. Si vous constatez 
à un moment ou un autre une réduction des performances due à un manque de 
mémoire RAM, fermez une ou plusieurs applications ou un ou plusieurs projets afin 
de libérer de la mémoire RAM pour le reste des projets ouverts.
Pour ouvrir un ou plusieurs fichiers de projet dans le Finder, procédez de l’une 
des manières suivantes :
m Double-cliquez sur un fichier de projet Motion. Motion s’ouvre automatiquement 
avec ce projet.
m Sélectionnez un ou plusieurs fichiers de projet Motion, puis faites-les glisser sur l’icône 
de l’application Motion située dans le dossier Applications ou dans le Dock si vous 
en avez placé une à cet emplacement. 
m Sélectionnez un ou plusieurs fichiers de projet Motion, puis choisissez Fichier > Ouvrir 
(ou appuyez sur les touches Commande + O) dans le Finder.
m Sélectionnez un ou plusieurs fichiers de projet Motion, cliquez sur l’un d’eux en maintenant la touche Contrôle enfoncée, puis choisissez Ouvrir dans le menu contextuel.
Motion démarre automatiquement et ouvre tous les projets sélectionnés.
Pour ouvrir un fichier de projet à partir de Motion avec la commande Ouvrir :
1 Choisissez Fichier > Ouvrir (ou appuyez sur les touches Commande + O).
La zone de dialogue Ouvrir apparaît.
2 Dans la zone de dialogue Ouvrir, naviguez jusqu’au fichier de projet souhaité, 
puis cliquez sur Ouvrir.
Pour ouvrir un fichier de projet à partir du Navigateur Motion :
1 Dans le Navigateur, naviguez jusqu’au fichier de projet souhaité et sélectionnez-le.
2 Procédez de l’une des manières suivantes :
Â Double-cliquez sur le fichier de projet.
Â Cliquez sur le bouton Importer dans la zone de Preview.
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Ouverture des projets récents
Chaque projet que vous ouvrez dans Motion est automatiquement ajouté au sous-menu 
Ouvrir récent situé dans le menu Fichier. Ce sous-menu permet de choisir un projet 
dans une liste des projets sur lesquels vous avez récemment travaillé. Motion contient 
un sous-menu Ouvrir récent dans lequel sont conservés les noms des projets antérieurs 
sur lesquels vous avez travaillé.
Pour ouvrir un projet récent :
m Dans le menu Fichier, choisissez le nom de fichier d’un projet dans le sous-menu 
Ouvrir récent.
Si le sous-menu Ouvrir récent vous semble trop encombré, vous pouvez l’effacer.
Pour effacer le sous-menu Ouvrir récent :
m Choisissez Fichier > Ouvrir récent > Effacer le menu.
Fermeture des projets
Vous pouvez fermer les projets l’un après l’autre ou tous à la fois. Pour fermer un projet, 
il suffit de fermer sa fenêtre de projet (la fenêtre contenant le Canevas).
Pour fermer un projet, procédez de l’une des manières suivantes :
m Appuyez simultanément sur les touches Contrôle + W pour fermer la fenêtre 
actuellement activée.
m Cliquez sur le bouton de fermeture de la fenêtre du Canevas.
Pour fermer tous les projets ouverts, procédez de l’une des manières suivantes :
m Appuyez simultanément sur les touches Commande + Option + W.
m Cliquez sur le bouton de fermeture avec la touche Option enfoncée.
Remarque : en fonction de la version, le fait de cliquer sur le bouton de fermeture 
avec la touche Option enfoncée pour fermer tous les projets ouverts peut ne pas 
fonctionner avec votre système d’exploitation.
Gestion de plusieurs projets ouverts
Chaque projet ouvert est autonome dans sa propre fenêtre et possède ses propres 
onglets Couches, Média, Audio, Timeline, Images clés et Éditeur audio.
Vous pouvez utiliser la commande Exposé Toutes les fenêtres (sous Mac OS X v10.4 
et les versions ultérieures) pour afficher en même temps toutes les fenêtres des projets 
ouverts. Pour en savoir plus sur l’utilisation d’Exposé, consultez l’Aide Mac, disponible 
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Déplacement et archivage des fichiers de projetMotion
Pour transférer un fichier de projet Motion vers un autre ordinateur, il est nécessaire 
de transférer également tous les médias utilisés par le projet, y compris tous les élé-
ments QuickTime, les images fixes et les fichiers audio. De plus, si votre projet utilise 
des modules Motion de tierce partie ou des polices non standard ou LiveFonts, 
vous devez vous assurer que ces éléments sont installés sur l’ordinateur vers lequel 
vous transférez le projet, sinon ils ne seront pas disponibles pour votre projet.
De même, une fois que vous avez terminé un projet et que vous souhaitez l’archiver, 
il est recommandé d’archiver non seulement le fichier de projet, mais également tous 
les médias (plus particulièrement ceux qui n’ont pas été capturés à partir d’une source 
vidéo ou audio dotée du contrôle de périphérique), les éléments graphiques, les polices, 
les comportement personnalisés, les filtres ou les modules de tierce partie utilisés par 
ce projet. Lorsque vous souhaiterez restaurer le projet pour effectuer des révisions 
ultérieures, vous disposerez de tous les éléments nécessaires pour être rapidement 
à pied d’œuvre. Si vous disposez d’un graveur de CD ou de DVD, il sera facile de sauvegarder vos médias. Pour en savoir plus sur la copie de fichiers sur un CD ou un DVD 
enregistrable, consultez l’Aide Mac dans le menu Aide du Finder.
La méthode la plus simple pour regrouper tous les médias utilisés dans votre projet 
consiste à utiliser l’option Recueil données. reportez-vous à la section « Recueil des 
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Remarque : si vous transférez un projet vers un autre ordinateur sans utiliser l’option 
Recueil données, ses médias risquent d’être déconnectés, même si vous les avez déplacés en même temps. Pour en savoir plus sur la manière de reconnecter les fichiers de 
médias à votre projet, lisez la rubrique « Comparaison entre les médias connectés et 
déconnectés » à la page 245.
Médias inutilisés
Par défaut, tous les médias utilisés par des objets ajoutés à votre projet sont automatiquement gérés par Motion. Si vous supprimez un objet dans le Canevas ou la liste de 
couches, le média source correspondant est automatiquement supprimé de l’onglet 
Média. Vous pouvez toutefois désactiver cette fonction dans la sous-fenêtre Générales 
des préférences Motion.
Archivage des éléments vidéo QuickTime
Si vous utilisez des plans vidéo QuickTime dans un projet Motion que vous souhaitez 
archiver en vue d’un stockage à long terme, la décision d’archiver également les plans 
vidéo dépend de la manière dont ils ont été capturés. Si vous avez capturé votre vidéo 
via Final Cut Express HD ou Final Cut Pro à l’aide d’un caméscope ou d’une platine 
dotée du contrôle de périphérique, l’archivage de vos plans vidéo risque d’être inutile. 
Cela est dû au fait qu’il est toujours possible de recapturer les plans à partir des bandes 
originales, à l’aide du fichier de projet Final Cut dans lequel vous les avez consignés. 
Dans ce cas, il est recommandé de sauvegarder le fichier de projet Final Cut Express 
HD ou Final Cut Pro, en plus de votre fichier de projet Motion.
Si vous avez capturé votre vidéo sans contrôle de périphérique ou que la vidéo a été 
capturée par une autre personne et que vous ne pouvez plus recapturer les plans 
exactement comme ils apparaissent dans votre projet, il est recommandé de sauvegarder ces plans avec le reste des fichiers graphiques, fichiers audio et polices utilisés 
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Recherche de projets à l’aide du Finder
Spotlight indexe certaines propriétés de vos projets Motion, ce qui vous permet de lancer 
des recherches avancées. Utilisez Spotlight dans le Finder pour bénéficier de cette fonction. 
Les propriétés suivantes des projets Motion sont indexées par Spotlight et peuvent donc 
servir de critères de recherche : 
Modification des propriétés de projet
Même si tous les projets démarrent avec un groupe prédéfini de propriétés de projet, 
vous pouvez les modifier à tout moment, même après avoir ajouté des objets.
Pour modifier les propriétés d’un projet :
1 Choisissez Édition > Propriétés du projet (ou appuyez sur les touches Commande + J).
2 Dans la zone de dialogue Propriétés du projet, modifiez les paramètres nécessaires, 
puis cliquez sur OK.
Pour en savoir plus sur les paramètres disponibles dans la zone de dialogue Propriétés 
du projet, voir « Onglet Générales de la zone de dialogue Propriétés du projet » à la 
page 202 et « Onglet Réglages de rendu de la zone de dialogue Propriétés du projet » 
à la page 206.
La plupart des modifications apportées aux propriétés d’un projet sont plutôt transparentes et n’ont aucun impact visuel sur le projet proprement dit. La modification 
des dimensions d’image du projet constitue l’exception principale à cette règle.
Propriété de projet Description
Largeur Largeur du projet en pixels
Hauteur Hauteur du projet en pixels
Durée Durée du projet en secondes
Nom de la couche Nom de n’importe quelle couche de votre projet
Nom du média Nom de n’importe quel objet de média dans votre projet
Chemin d’accès Chemin menant à n’importe quel objet de média dans votre projet
Texte Contenu de tout objet texte dans votre projet
Description Texte contenu dans le champ Description des Propriétés du projet
Nom du marqueur Nom de n’importe quel marqueur présent dans la Timeline de votre projet
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Modification de la taille d’image d’un projet
La modification des dimensions d’image d’un projet (dans Propriétés du projet) 
contenant déjà des objets modifie en fait la taille du Canevas. Cela augmente ou 
réduit la quantité d’espace disponible pour disposer les objets dans votre projet. 
Il est important de comprendre que la modification de la taille du Canevas ne modifie 
d’aucune manière la taille ou la position de tout objet qui s’y trouve. En outre, comme 
le système de coordonnées utilisé par Motion utilise le point 0, 0 comme centre du cadre, 
tous les objets demeurent en place à leur position actuelle par rapport au centre du cadre 
alors que le contour de ce dernier se réduit en direction du centre. Les objets risquent 
d’être coupés si le cadre dépasse leurs contours en rétrécissant. Dans l’exemple qui suit, 
un projet dont les dimensions d’image sont de 720 x 480 est réduit à 320 x 240.
Remarque : comme Motion fonctionne indépendamment de la résolution choisie, 
il est généralement inutile de modifier la taille d’image de votre projet. Vous pouvez sortir 
vos projets dans n’importe quelle taille, quelles que soient les dimensions d’image actuelles, en modifiant les options des zones de dialogue d’exportation de Motion. Ainsi, si vous 
êtes en train de créer un projet dont les dimensions sont adaptées à une diffusion en résolution standard, vous pouvez toujours exporter une version de votre projet en résolution 
moyenne pour la publier sur le web en effectuant une exportation à la taille nécessaire.
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Navigation parmi les fichiers de médias dans Motion
Cette section explique comment naviguer parmi les fichiers de médias que vous souhaitez 
utiliser dans votre projet Motion. Comme pour les fichiers de projet, il est important 
de s’assurer que les médias sources utilisés sont organisés de manière logique et qu’il 
est facile d’en effectuer le suivi. Il peut s’avérer utile de centraliser tous les médias sources 
qui ne seront utilisés que dans un seul projet et d’organiser méticuleusement ceux 
qui seront partagés par plusieurs projets.
Le Navigateur permet de naviguer à travers tous les volumes connectés à votre ordinateur afin d’y rechercher des fichiers de médias à ajouter à votre projet Motion. Bien que 
similaire à une fenêtre du Finder, le Navigateur possède de nombreuses commandes 
personnalisées propres à Motion, qui vous permettent de retrouver rapidement et 
de prévisualiser les fichiers que vous pourriez utiliser.
Remarque : vous pouvez également rechercher et importer des fichiers à partir de vos 
bibliothèques iTunes et iPhoto, directement depuis la Bibliothèque Motion. Pour en savoir 
plus, voir « Ajout de fichiers iTunes et iPhoto à partir de la Bibliothèque » à la page 242.Chapitre 2 Création et gestion de projets 221
Commandes de navigation du Navigateur
Barre latérale du Navigateur : cette zone du Navigateur affiche tous les disques 
durs et supports amovibles connectés à votre ordinateur. Elle vous permet également 
d’accéder à des volumes en réseau. Des icônes supplémentaires vous donnent accès 
aux dossiers fréquemment utilisés de votre répertoire de départ, tels que les dossiers 
Bureau, Documents, Films, Musique et Images.
Pile de fichiers : située sous la barre latérale du Navigateur, la pile de fichiers affiche 
tous les fichiers et dossiers qui se trouvent dans le disque sélectionné dans la barre 
latérale. Un clic sur un dossier permet d’en ouvrir le contenu dans la pile de fichiers, 
ce qui remplace le contenu affiché. Vous pouvez naviguer vers le haut ou vers le bas 
de la hiérarchie de dossiers à l’aide des boutons Suivant et Précédent, ainsi que 
du menu local Chemin. Il est possible d’alterner la présentation de la pile de fichiers 
sous forme de liste ou d’icônes.
Zone de Preview
Barre latérale
Pile de fichiers
Boutons Affichage
Champ de recherche
Menu local Chemin
Boutons Suivant/Précédent
Bouton Nouveau dossier
Curseur Échelle Bouton Afficher les séquences d’images réduites222 Chapitre 2 Création et gestion de projets
Zone de Preview : affiche un aperçu du fichier sélectionné dans la pile de fichiers. 
Si l’élément sélectionné est un film, le bouton de lecture apparaît pour que vous puissiez 
le visionner. Les informations du plan en cours de prévisualisation sont affichées à droite 
de la vignette de Preview.
Boutons Précédent et Suivant : ces boutons vous permettent d’accéder directement aux 
éléments répertoriés dans votre historique de navigation. Cliquez sur la flèche vers la gauche pour revenir au dernier élément parcouru. Le fait de cliquer de manière répétée sur 
cette flèche vous permet de remonter jusqu’au premier élément sélectionné (le Bureau, 
une partition ou votre dossier de départ, par exemple). Une fois que vous avez atteint le 
début de votre historique de navigation, la flèche vers la gauche est estompée. Cliquez 
sur la flèche vers la droite pour faire défiler votre historique de navigation. Si vous n’aviez 
encore ouvert aucun dossier au sein du dossier ouvert dans la pile de fichiers, la flèche 
vers la droite est estompée.
Menu local Chemin : affiche la hiérarchie de dossiers actuelle sous la forme d’une liste, 
le dossier ouvert se trouvant au sommet et chaque dossier parent successif apparaissant 
en dessous. « Ordinateur » apparaît en bas de liste et correspond au répertoire du sommet 
de la hiérarchie, qui comprend tous les disques connectés à votre ordinateur.
Champ de recherche : le champ Rechercher filtre la pile de fichiers à la recherche 
des termes que vous avez saisis.
Commandes de personnalisation du Navigateur
Séparateur du Navigateur : en faisant glisser ce séparateur vers le haut ou vers le bas, 
vous pouvez redéfinir l’espace alloué à la barre latérale du Navigateur et à la pile de 
fichiers. La réduction de la barre latérale provoque également la réduction, jusqu’à 
un certain point, des icônes affichées.
Bouton de présentation sous forme d’icônes : représente les fichiers et les dossiers 
de la pile sous forme d’icônes. Les fichiers d’image et de séquence sont représentés 
par des vignettes, tandis que les dossiers sont représentés par des icônes de dossier. 
Toutes les icônes de la pile sont disposées sur une grille dont la taille est définie par 
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Bouton de présentation sous forme de liste : représente les fichiers et les dossiers de 
la pile sous forme de liste hiérarchisée. Une vignette de fichier ou de dossier est affichée 
à gauche du nom de chaque fichier ou dossier dans la colonne Nom. À droite, plusieurs 
colonnes supplémentaires affichent la date, la taille, la durée et le type de chaque 
fichier. Vous pouvez trier le contenu de la pile de fichiers en fonction de n’importe 
quelle colonne en cliquant sur l’en-tête de cette dernière. Pour inverser l’ordre de tri, 
afin de passer de l’ordre ascendant à l’ordre descendant et vice versa, cliquez une 
deuxième fois sur l’en-tête.
Les dossiers qui figurent dans cette liste peuvent être ouverts soit hiérarchiquement 
à l’aide des triangles d’affichage placés à gauche de chaque icône de dossier, soit en 
double-cliquant dessus pour remplacer le contenu actuel de la pile de fichiers par 
celui du dossier.
Curseur Échelle : en mode de présentation par icônes, ce curseur augmente ou réduit 
la taille de toutes les icônes affichées dans la pile de fichiers. La taille actuelle détermine 
le nombre d’icônes que l’on peut afficher simultanément dans la zone actuelle de 
la pile de fichiers. Il est possible d’agrandir la pile de fichiers à l’aide du séparateur 
du Navigateur.
Bouton de présentation
sous forme d’icônes
Bouton de présentation 
sous forme de liste
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Bouton d’affichage réduit des séquences d’images : les séquences d’images sont 
des plans qui ont été enregistrés comme fichiers d’images individuels, chaque fichier 
correspondant à une image du film ou de la vidéo. En cliquant sur ce bouton vous 
pouvez visionner des fichiers de séquences d’images correctement nommés comme 
s’il s’agissait d’un fichier de séquence d’images unique. Si vous êtes en train de visionner 
des fichiers d’images dont les noms de fichier numérotés ne constituent pas réellement 
une séquence d’images (telles les images capturées à l’aide d’un appareil photo numérique et importées depuis un répertoire iPhoto), vous pouvez désactiver cette commande 
pour visionner séparément chaque fichier d’image individuel.
Bouton Nouveau dossier : cette commande permet de créer un dossier à l’emplacement 
actuel de la pile de fichiers. Ces dossiers sont créés dans le Finder et vous permettent 
de réorganiser les fichiers de médias sur le disque à partir de Motion.
Remarque : pour supprimer un dossier à partir du Navigateur, sélectionnez ce dossier, 
puis appuyez sur les touches Commande + Supprimer.
Différentes méthodes de navigation, de recherche et prévisualisation 
des fichiers
Cette section contient des procédures que vous pouvez utiliser pour rechercher 
et afficher un Preview des fichiers à l’aide des commandes du Navigateur.
Pour naviguer à travers le contenu d’un disque, procédez de l’une des manières 
suivantes :
m Cliquez sur l’icône du disque dans la barre latérale du Navigateur.
m Appuyez sur les flèches vers le haut et vers le bas pour monter et descendre dans 
la liste de la barre latérale.
Pour naviguer dans la pile de fichiers présentée sous forme d’icônes, 
procédez de l’une des manières suivantes :
m Double-cliquez sur un dossier de la pile de fichiers afin d’en ouvrir le contenu dans 
la pile de fichiers.
m Cliquez sur une icône de la pile de fichiers, puis appuyez sur les touches fléchées 
pour changer de dossier sélectionné. Pour ouvrir le dossier sélectionné, appuyez 
sur la touche Retour.
Pour naviguer dans la pile de fichiers présentée sous forme de liste, 
procédez de l’une des manières suivantes :
m Double-cliquez sur un dossier de la pile de fichiers afin d’en ouvrir le contenu dans 
la pile de fichiers.
m Cliquez sur le triangle d’affichage situé à gauche de l’icône d’un dossier pour ouvrir 
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m Cliquez sur un élément de la liste, puis appuyez sur les flèches vers le haut et vers le bas 
afin de naviguer dans la liste. 
m Appuyez sur la touche Flèche vers la droite pour ouvrir le dossier sélectionné en pré-
sentation hiérarchique (ce qui revient à cliquer sur le triangle d’affichage d’un dossier). 
Appuyez sur la touche Flèche vers la gauche pour fermer un dossier précédemment 
ouvert en présentation hiérarchique.
m Appuyez sur la touche Retour pour ouvrir le contenu d’un dossier dans la pile de fichiers.
Pour naviguer dans la hiérarchie actuelle des chemins d’accès, procédez de l’une 
des manières suivantes :
m Cliquez sur le bouton Suivant pour passer au dossier précédemment ouvert.
m Cliquez sur le bouton Précédent pour accéder au dernier dossier ouvert dans 
la hiérarchie de dossiers actuelle.
m Choisissez un dossier dans la hiérarchie actuelle via le menu local Chemin.
Pour trier la pile de fichiers présentée sous forme de liste :
m Cliquez sur l’en-tête de n’importe quelle colonne d’informations pour trier la pile 
en fonction de cette colonne. Pour inverser l’ordre de tri, afin de passer de l’ordre 
ascendant à l’ordre descendant et vice versa, cliquez une deuxième fois sur l’en-tête.
Pour rechercher un fichier :
m Tapez un terme à rechercher dans le champ Rechercher. La pile de fichiers est immédiatement mise à jour avec les fichiers dont les noms contiennent le terme recherché. 
La recherche est effectuée uniquement parmi les disques ou les dossiers affichés dans la 
pile de fichiers. Les majuscules ne sont pas prises en compte.. 
Par exemple, la saisie de « flag » dans le champ de recherche peut entraîner l’affichage 
des noms de fichiers suivants dans la pile de fichiers : « Dutch Flag.tif, flagAnimation.mov, 
flagellum.tif, Iron Flag.m4a. »
Pour effacer les résultats de recherche :
m Cliquez sur le bouton Effacer, situé à l’extrême droite du champ Rechercher, pour restaurer 
le contenu affiché précédemment dans la pile de fichiers.
Pour afficher le Preview d’un fichier :
m Sélectionnez n’importe quel fichier de médias compatible dans la pile de fichiers. 
La zone de Preview est mise à jour avec une vignette et un texte d’informations 
supplémentaires sur le fichier. Si l’option « Lire automatiquement les éléments en 
un seul clic » est activée dans l’onglet Générales des préférences Motion, la lecture 
d’un Preview animé des plans du film et des séquences d’images commence.226 Chapitre 2 Création et gestion de projets
Pour afficher un Preview en taille normale d’un fichier :
m Double-cliquez sur un fichier dans la pile de fichiers, afin de l’ouvrir dans sa propre 
fenêtre munie de commandes de lecture.
Types de fichiers pris en charge par Motion
Motion peut utiliser la plupart des formats de fichiers multimédias compatibles 
avec QuickTime. Ces formats peuvent être classés dans les catégories suivantes :
Â Séquences QuickTime
Â Séquences d’images
Â Fichiers d’image fixe
Â Fichiers Photoshop en couches
Â Fichiers PDF
Â Fichiers audio
À propos des disques en réseau et des supports amovibles
Soyez prudent lorsque vous ajoutez des fichiers de médias dans votre projet à partir 
d’un serveur distant. Bien que la barre latérale du Navigateur vous permette d’accéder 
aisément au contenu des disques situés sur d’autres ordinateurs de votre réseau, 
cette procédure ne fait que placer dans votre projet un lien vers le fichier concerné. 
Le fichier de média proprement dit demeure sur le disque distant à l’endroit où vous 
l’avez trouvé. Par conséquent, l’objet placé dans votre projet ne sera plus accessible 
chaque fois que le disque distant sera indisponible. De plus, il se peut qu’en fonction 
de la vitesse de votre réseau, vous soyez confronté à des problèmes de performance 
lors de l’utilisation de fichiers de médias situés sur d’autres ordinateurs. La procédure 
idéale consiste à copier tous les fichiers de médias que vous souhaitez utiliser dans 
votre projet sur un disque physiquement connecté à votre ordinateur, afin d’assurer 
la disponibilité future du fichier et de garantir un certain niveau de performances 
de lecture. Si vous utilisez des médias situés sur un disque dur connecté en réseau, 
assurez-vous qu’il s’agit d’un disque monté en permanence sur votre système et que 
les performances de votre réseau sont suffisamment élevées.
Cela est particulièrement vrai pour les médias stockés sur des disques amovibles, 
tels que les CD-ROM, DVD-ROM et disques durs amovibles, qui sont fréquemment 
déconnectés de votre ordinateur. Copiez toujours les fichiers de médias stockés 
sur de tels supports sur votre disque dur local, afin qu’ils ne deviennent pas indisponibles 
si le support est éjecté ou déconnecté.Chapitre 2 Création et gestion de projets 227
Séquences QuickTime
Motion prend en charge les séquences QuickTime utilisant les codecs installés sur 
votre ordinateur. Vous pouvez notamment importer les séquences QuickTime 
suivantes : les plans capturés avec Final Cut Express HD ou Final Cut Pro, les séquences 
tirées d’un CD-ROM ou d’un DVD, ou les animations générées sur ordinateur à l’aide 
d’un logiciel d’animation 3D.
Bien que vous puissiez importer des séquences utilisant pratiquement n’importe 
quel codec, nous vous conseillons vivement d’éviter autant que possible l’utilisation 
de plans fortement compressés dans vos projets. Ce type de plan risque de présenter 
des artefacts indésirables à l’écran. Bien heureusement, QuickTime est fourni avec 
de nombreux codecs idéaux pour le transfert de fichiers vidéo non compressés ou très 
peu compressés d’une application à l’autre, parmi lesquels on trouve notamment les 
codecs : Sans compression 8 et 10 bits 4:2:2, Pixlet, Aucun, Animation, Apple M-JPEG A 
et B, Apple DVCPRO-50, ainsi que Apple DV/DVCPRO et Apple ProRes 422.
Certains de ces codecs prennent en charge les canaux alpha qui définissent les zones 
de transparence au sein d’un plan. Si un plan QuickTime particulier possède un canal 
alpha, Motion l’utilise automatiquement dans votre projet.
Association de différents types de fichiers QuickTime
Vous pouvez combiner librement dans le même projet des plans compressés à l’aide de 
codecs différents. De plus, il est également possible de combiner des plans présentant 
des dimensions d’image, proportions pixel et types d’entrelacement différents. Pour en 
savoir plus sur les canaux alpha, l’entrelacement, les proportions pixel, les fréquences 
d’images et les dimensions d’image, lisez la rubrique « Formats vidéo et de fichiers » à 
la page 1293.
Avertissement : le mélange de plans présentant différentes fréquences d’images peut 
provoquer des anomalies de mouvement.
Importation de films à partir de Final Cut Express HD ou Final Cut Pro
Contrairement à Final Cut Express HD ou Final Cut Pro, Motion traite la vidéo dans 
l’espace colorimétrique RVB. Les plans vidéo capturés en YCrCb sont traités comme 
des plans RVB lorsqu’ils sont importés dans un projet Motion.228 Chapitre 2 Création et gestion de projets
Images fixes
Vous pouvez importer des fichiers d’images fixes dans pratiquement tous les formats 
d’images fixes courants, y compris notamment les formats : SGI, Photoshop, BMP, PICT, 
JPEG, TIFF, TGA et JPEG-2. Comme pour les plans vidéo, vous pouvez mélanger 
des fichiers d’images fixes présentant des dimensions d’image et des proportions pixel 
différentes. Lorsque vous créez ou modifiez une image dans une application de traitement d’images telle que Photoshop, il est conseillé de garder à l’esprit les dimensions 
d’image et les proportions pixel de votre projet, afin de vous assurer que les éléments 
graphiques créés sont adaptés au projet. Pour en savoir plus, voir « Formats vidéo et de 
fichiers » à la page 1293.
Utilisation d’images fixes à haute résolution
L’animation de fichiers d’images fixes à haute résolution est d’un usage courant et efficace dans les projets d’animation graphique. Le nombre de points par pouce, utilisé dans 
les applications telles que Photoshop, ne s’applique pas à la vidéo, les dimensions de chaque image fixe importée étant simplement définies par le nombre de pixels. Si les dimensions actuelles d’une image sont supérieures aux dimensions d’image de votre projet, 
l’image apparaît beaucoup plus grande, et semble par défaut « agrandie » à sa taille maximale. Vous pouvez modifier l’échelle de l’image afin de réduire cette dernière pour l’adapter aux dimensions d’image du projet, animer l’échelle pour effectuer un zoom avant ou 
arrière sur l’image ou bien animer la position de l’image afin d’effectuer un panoramique 
à l’intérieur de l’image, créant ainsi toutes sortes d’effets de mouvement.
Étant donné que Motion ne dépend pas de la carte graphique, vous pouvez être 
confronté à différentes limitations de taille de fichier pour l’importation. Lors de 
l’importation d’une image trop volumineuse, une zone de dialogue d’avertissement 
vous indique « Ce média est trop volumineux pour être rendu en haute résolution, 
il s’affichera en basse résolution ». Cliquez sur OK pour importer l’image à une qualité 
inférieure. Pour en savoir plus à ce sujet, visitez le site web de Motion à l’adresse 
suivante : http://www.apple.com/fr/finalcutstudio/Motion.
Lors de l’importation de grandes images fixes, vous pouvez définir une préférence afin 
d’indiquer à Motion d’importer le fichier à sa taille d’origine, de changer la résolution 
de l’image en fonction de la taille du Canevas, ou de dimensionner l’image à la taille 
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Pour définir la préférence d’importation des grandes images fixes :
1 Choisissez Motion > Préférences (ou appuyez sur touches Commande + virgule).
2 Dans le groupe Images et objets des préférences relatives aux projets de Motion, 
choisissez un réglage dans le menu local Grandes images.
Il existe trois options : Ne rien faire, Adapter au Canevas et Réduire à la taille du Canevas.
Ne rien faire : importe l’image à sa taille d’origine.
Dans l’exemple suivant, une image 1 146 x 756 est importée dans un projet NTSC D1 
(720 x 486), alors que l’option Ne rien faire est sélectionnée dans les préférences. 
L’image est beaucoup plus grande que le Canevas.
Adapter au Canevas : importe et dimensionne l’image en fonction de la taille du projet, 
tout en préservant ses proportions.
Cliquez pour choisir les préférences 
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Dans l’exemple suivant, une image JPEG 760 x 1 150 est importée dans un projet 
NTSC D1, alors que l’option Adapter au Canevas est sélectionnée dans les préférences.
L’image est mise à l’échelle, opération équivalente à l’utilisation de l’outil Transformer 
pour réduire l’image dans le Canevas tout en appuyant sur Maj. Pour remarquer que 
l’image est simplement transformée et que sa résolution n’a pas changé, sélectionnez 
le fichier d’image sous l’onglet Média de la sous-fenêtre Projet, puis affichez l’Inspecteur 
sous l’onglet Média. Les paramètres Largeur fixe et Hauteur fixe affichent la résolution 
du fichier original.
L’image est dimensionnée afin d’adapter la valeur X ou Y la plus élevée de l’image 
à celle du Canevas.
Réduire à la taille du Canevas : ce réglage change la résolution de l’image importée, 
de sorte qu’elle s’adapte à la taille du projet tout en conservant ses proportions.
Remarque : l’option Réduire à la taille du Canevas constitue le meilleur choix pour 
optimiser le temps de traitement. Lorsque vous utilisez l’option Adapter au Canevas, 
Motion doit recalculer l’échelle à chaque image.
La résolution de l’image d’origine reste inchangée.Chapitre 2 Création et gestion de projets 231
Dans l’exemple suivant, une image JPEG de 1 309 x 2 020 est importée dans un projet 
NTSC Broadcast SD, alors que l’option « Réduire à la taille du Canevas » est sélectionnée 
dans les préférences.
L’image semble identique à une image dimensionnée lors de l’importation. Cependant, 
sa résolution a changé, de sorte que l’image est adaptée au Canevas. Pour remarquer 
que la résolution de l’image a changé, sélectionnez le fichier d’image sous l’onglet Média 
de la sous-fenêtre Projet, puis affichez l’Inspecteur sous l’onglet Média. Les paramètres 
Largeur fixe et Hauteur fixe affichent la nouvelle résolution de l’image importée.
Durée des images fixes
Lorsque vous importez pour la première fois une image fixe dans votre projet, 
elle adopte par défaut une durée égale à la durée actuelle de votre projet. Toute augmentation de la durée de votre projet n’entraîne pas automatiquement une augmentation de la durée des images qui ont déjà été importées. Les images fixes ont une durée 
infinie dans Motion, ce qui vous permet de les étirer autant que vous le souhaitez dans 
la Timeline. Pour en savoir plus sur la manipulation des objets dans la Timeline, lisez 
la rubrique « Utilisation de la Timeline » à la page 353.
La résolution de l’image originale est changée, 
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Séquences d’images
Les séquences d’images numérotées permettent de stocker des plans vidéo sous la forme 
de fichiers d’images fixes individuels. Le nom de chaque fichier d’image comprend un 
numéro indiquant la position de l’image dans la séquence. Dans un plan de film scanné, 
chaque fichier représente une image individuelle. Dans un plan vidéo converti en 
séquence d’images, chaque fichier contient les deux trames d’une image vidéo individuelle, les lignes supérieures et inférieures de l’image ayant été enregistrées ensemble. 
Les séquences d’images utilisent la même gamme de formats de fichier que les fichiers 
d’images fixes. Parmi les formats les plus populaires pour l’enregistrement de séquences 
d’images on trouve les formats : SGI, BMP, JPEG, TIFF et TGA. Comme pour les formats 
d’images fixes, nombre de ces formats prennent en charge les canaux alpha qui sont 
automatiquement utilisés par Motion.
La longévité des séquences d’images (avant QuickTime, il s’agissait du seul moyen 
de stocker de la vidéo sur un ordinateur) en fait le format de fichier représentant le 
plus petit dénominateur commun pour l’échange de vidéo entre différentes applications de compositing et de montage. Même si QuickTime est de plus en plus utilisé 
pour l’échange de plans vidéo entre plates-formes, les séquences d’images sont toujours très courantes surtout dans le domaine du compositing.
Comme avec les plans vidéo QuickTime, vous pouvez mélanger divers formats 
de séquences d’images présentant des dimensions d’images, proportions pixel, 
fréquences d’images et types d’entrelacement différents. Pour en savoir plus, 
voir « Formats vidéo et de fichiers » à la page 1293.
Important : le nom de toute séquence d’images importée doit contenir au moins 
trois chiffres de remplissage, comme nom_image.0001.tif.
Réduction des séquences d’images
Le bouton d’affichage réduit des séquences d’images situé en bas du Navigateur 
vous permet d’afficher les séquences d’images comme s’il s’agissait d’un seul objet, 
plutôt qu’une collection de fichiers individuels stockés sur votre disque. Les séquences 
d’images que vous importez de cette manière dans votre projet sont traitées comme 
des objets uniques partout où elles apparaissent dans votre projet.
Remarque : vous pouvez désactiver cette fonction si vous disposez de fichiers d’images 
numérotés qui ne sont pas destinés à être utilisés comme séquences d’images. Les images 
prises à l’aide d’appareils photo numériques, par exemple, possèdent souvent des 
noms de fichier numérotés que l’on peut confondre avec une séquence d’images.
Cliquez ici pour réduire ou développer
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Fichiers Photoshop multicouches
Vous pouvez également importer des fichiers Photoshop multicouches. De nombreux 
professionnels de l’animation graphique créent des maquettes dans Photoshop, où ils 
dessinent et manipulent tous les éléments graphiques qu’ils utiliseront pour créer une 
composition statique. Une fois cette étape terminée, le fichier multicouche créé peut 
être importé dans Motion pour y être animé, avec d’autres objets importés ou générés 
par Motion, afin de créer le projet final.
Lorsque vous importez des fichiers Photoshop, vous pouvez choisir d’importer :
Â Toutes les couches fusionnées en un seul objet
Â Toutes les couches comme des objets distincts imbriqués au sein d’un seul groupe
Â Une couche individuelle en tant qu’objet unique
Si vous importez toutes les couches comme des objets distincts, Motion crée un nouveau groupe dans l’onglet Couches et la Timeline, puis imbrique chaque couche du 
fichier Photoshop en tant qu’objet individuel au sein de ce groupe Motion. Chaque 
objet résultant garde la position, l’opacité et le mode de fusion de la couche Photoshop originale. De plus, les couches de texte Photoshop sont importées, mais elles 
apparaissent dans Motion sous la forme d’images bitmap non modifiables. 
Effets incompatibles
Les effets Photoshop suivants ne sont pour le moment pas importés dans Motion : 
Â Effets de couche
Â Masques de couches
Â Couches d’ajustement
Â Chemins
Â Formes
Remarque : Motion ne prend pas en charge les ensembles de couches Photoshop.
Pour en savoir plus sur la manière d’importer des fichiers Photoshop multicouches, 
lisez la rubrique « Ajout de fichiers Photoshop multicouches à un projet » à la page 241.
Fichiers PDF
Le format de fichier PDF est un format de document utilisant Postscript adapté au texte 
et aux images Postscript ainsi qu’aux images bitmap. Les zones de transparence d’un 
fichier PDF sont également transparentes dans Motion.
Les fichiers PDF peuvent contenir des illustrations Postscript. Contrairement aux formats de fichier graphique tels que TIFF et JPEG, qui enregistrent les images comme 
un ensemble de pixels à résolution fixe, répartis entre les canaux Rouge, Vert et Bleu, 
les illustrations Postscript sont enregistrées sous la forme d’une formule mathématique 
décrivant l’image. Les fichiers PDF contenant du texte et des images Postscript bénéficient par conséquent d’une résolution infinie.234 Chapitre 2 Création et gestion de projets
En pratique, la différence entre les fichiers bitmap et Postscript provient du fait que 
toute modification de l’échelle d’une image bitmap au-delà de 100 pour cent provoque 
un adoucissement progressif de l’image au fur et à mesure que l’on augmente sa taille. 
Les illustrations Postscript demeurent nettes et claires quelle que soit leur échelle.
Lors de l’importation d’un fichier PDF, la taille de ce dernier est relative à la taille de page 
originale du fichier. Par conséquent, même les petites images peuvent présenter des 
dimensions d’image importantes, avec un espace vide important autour de l’image. 
Lors de l’importation d’une image en tant que fichier PDF à utiliser dans Motion, il est 
parfois nécessaire d’augmenter la taille de l’image afin de mieux l’adapter à la page 
ou de réduire la taille de la page via les préférences Format de l’application source afin 
qu’elle cadre mieux l’image.
Résolution fixe d’un objet PDF
Bien que les fichiers PDF disposent d’une résolution illimitée, les objets PDF de taille 
importante peuvent occuper une grande partie de la mémoire vidéo, ce qui risque 
de limiter les performances de Motion. Pour l’éviter, vous avez la possibilité de limiter 
la résolution de chaque image PDF utilisée dans votre projet afin d’économiser de la 
mémoire vidéo. Grâce aux paramètres Résolution fixe, les fichiers ne doivent être rendus qu’une seule fois. Cela permet de meilleures performances en termes de rapidité.
Si vous décidez de fixer la résolution d’un fichier PDF, les valeurs de hauteur et de largeur que vous attribuez doivent correspondre aux dimensions maximales que vous 
comptez utiliser pour cet objet dans votre projet. Vous pouvez, par exemple, ajouter à 
votre projet une carte au format PDF sur laquelle il sera possible d’effectuer un zoom 
avant sur un pays particulier. Pour économiser de la mémoire vidéo, vous pouvez donner aux paramètres Largeur fixe et Hauteur fixe la taille maximale de l’image agrandie 
par le zoom avant. Si la résolution attribuée s’avère insuffisante, vous pouvez toujours 
modifier à tout moment les paramètres Largeur fixe et Hauteur fixe.
Les paramètres de résolution fixe des objets PDF peuvent être ajustés sous l’onglet 
Média de l’Inspecteur. Sélectionnez l’objet PDF sous l’onglet Média de la sous-fenêtre 
Projet afin d’activer l’onglet Média de l’Inspecteur.
Résolution fixe : cette case permet de fixer la résolution d’un objet PDF dans l’onglet 
Média en lui attribuant les dimensions spécifiées via les paramètres Largeur fixe 
et Hauteur fixe.
Largeur fixe : curseur qui définit la résolution horizontale maximale que peut atteindre 
un objet PDF.
Hauteur fixe : curseur qui définit la résolution verticale maximale que peut atteindre 
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Contenu mixte des fichiers PDF
Bien que les fichiers PDF puissent contenir simultanément des dessins Postscript, du 
texte Postscript et des images bitmap, tous ces types de données d’image ne peuvent 
être mis à l’échelle de la même manière. Les dessins et le texte Postscript peuvent faire 
l’objet d’une variation d’échelle sans problème, tandis que les images bitmap intégrées 
à un fichier PDF sont soumises aux mêmes limites d’échelle que tout autre format 
d’image bitmap. Elles risquent par conséquent de devenir plus floues si elles sont 
agrandies à une taille supérieure à leur taille originale. 
Remarque : les objets de forme, les boutons et les objets JavaScript présents dans 
un fichier PDF importé n’apparaissent pas dans Motion.
Fichiers PDF à plusieurs pages
Vous pouvez importer des fichiers PDF contenant plusieurs pages. Dans ce cas, un paramètre supplémentaire appelé Numéro de page apparaît dans l’onglet Propriétés lorsque 
l’objet PDF est sélectionné. Un curseur vous permet de déterminer la page à afficher 
dans le Canevas. Ce paramètre peut être animé pour afficher différentes pages au fil 
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Important : les fichiers PDF multicouches ne sont pour le moment pas pris en charge. 
Pour importer une illustration multicouche, il vous faut donc exporter chaque couche 
comme un fichier PDF séparé, puis importer les fichiers obtenus sous forme de groupe 
d’objets imbriqués dans Motion.
Informations supplémentaires sur les canaux alpha
Les plans vidéo et les fichiers d’image ordinaires comportent trois canaux d’informations, 
correspondant respectivement au canal rouge, vert et bleu. De nombreux formats 
de fichier et d’image prennent également en charge un canal alpha qui contient des 
informations supplémentaires définissant les zones de transparence. Un canal alpha 
est un canal en niveaux de gris, où le blanc représente les zones dont l’opacité est de 
100 pour cent (zones opaques), le gris représente les zones partiellement opaques et 
le noir représente les zones dont l’opacité est de 0 pour cent (zones transparentes).
Lorsque vous importez une séquence QuickTime ou un fichier d’image dans votre projet, son canal Alpha est immédiatement reconnu par Motion. Le canal alpha est ensuite 
utilisé pour effectuer le compositing de l’objet sur les objets se trouvant derrière. 
Il existe deux méthodes pour incorporer des informations de canal alpha dans 
les fichiers ; Motion essaie de déterminer automatiquement le type de canal alpha 
utilisé par un objet particulier :
Â Droit : les canaux alpha droits sont complètement séparés des canaux rouge, 
vert et bleu d’une image. Les fichiers de médias contenant des canaux alpha droits 
sont affichés de manière tout à fait normale dans une composition mais risquent 
de présenter des anomalies s’ils sont affichés dans une autre application. Les effets 
translucides tels que l’éclairage volumétrique ou les lumières parasites d’une image 
générée par ordinateur peuvent sembler déformés tant que le plan n’est pas utilisé 
dans une composition.
Â Prémultiplié : ce type de canal alpha est multiplié avec les canaux rouge, vert et bleu 
du plan. Par conséquent, les objets contenant des canaux alpha prémultipliés sont 
toujours de bonne qualité, même s’ils ont des effets de lumière translucide, car l’image 
entière est pré-composée sur du noir. Les canaux alpha prémultipliés sont plus généralement multipliés sur du noir ou du blanc, mais Motion peut également résoudre les 
canaux alpha prémultipliés sur d’autres couleurs.
La seule situation où il est important de connaître le type de canal alpha d’un objet 
est celle où Motion ne parvient pas à le déterminer de manière correcte. Si le canal 
alpha d’un objet a été réglé sur Droit dans l’onglet Média alors qu’il s’agit en réalité 
d’un canal alpha prémultiplié, il risque d’apparaître avec des franges de la couleur 
prémultipliée tout autour de ses bords. Si cela se produit, vous pouvez sélectionner 
le plan présentant cette anomalie dans l’onglet Média de la sous-fenêtre Projet 
et modifier son paramètre Type alpha dans l’onglet Média de l’Inspecteur.Chapitre 2 Création et gestion de projets 237
Fichiers audio
Vous pouvez importer différents formats de fichiers audio dans votre projet, y compris 
notamment les formats : WAV, AIFF, .cdda, MP3 et AAC. Bien que Motion ne constitue 
pas nécessairement un environnement de mixage et de montage audio doté de toutes 
les fonctions nécessaires, tel que Garage Band, Soundtrack Pro ou Logic, il vous permet 
d’importer des clips musicaux, des dialogues et des effets sonores afin de les utiliser dans 
vos projets. Si vous importez un fichier QuickTime comprenant des pistes audio mono ou 
stéréo, la vidéo apparaît dans la Timeline, alors que l’audio apparaît dans l’Éditeur audio.
À partir de Motion, vous pouvez sélectionner un fichier audio et ouvrir Soundtrack Pro 
pour modifier le fichier audio. Une fois enregistré dans Soundtrack Pro, le fichier 
est automatiquement mis à jour dans Motion. Pour en savoir plus, voir « Utilisation de 
Soundtrack Pro avec Motion » à la page 1232.
Vous pouvez librement importer des éléments audio présentant des fréquences 
d’échantillonnage et des débits différents. Lorsque vous faites cela, Motion ré-échantillonne 
les pistes audio qui le requièrent, afin de leur donner la fréquence d’échantillonnage et le 
débit actuellement utilisés par votre ordinateur. Les valeurs par défaut sont de 16 bits 
et 44,1 KHz flottant pour l’interface audio intégrée. Si vous utilisez une interface audio 
de tierce partie, l’audio est remixé avec la fréquence d’échantillonnage et le débit utilisé 
par ce périphérique.
Vous pouvez importer des fichiers audio avec des fréquences d’échantillonnage allant 
jusqu’à 192 kHz et des profondeurs de bits jusqu’à 32 bits. Les fichiers tant mono que 
stéréo sont gérés. Les fichiers audio multicanaux sont également pris en charge.
Sachez que même si Motion peut prendre en charge autant de couches audio que vous 
en utilisez dans l’Éditeur audio, le mixage de nombreuses pistes audio risque d’avoir 
une incidence sur les performances de lecture. L’Éditeur audio met à votre disposition 
des outils et des commandes de modification des objets audio identiques à ceux utilisés 
dans la liste de couches de la Timeline. Chaque couche audio possède également des 
réglages individuels de niveau et de balance, afin que vous puissiez mixer ensemble 
un groupe de pistes en vue d’une sortie stéréo.
Pour en savoir plus sur les formats de fichiers compatibles avec Motion, lisez la rubrique « Formats vidéo et de fichiers » à la page 1293. Pour en savoir plus sur l’utilisation 
des données audio dans Motion, lisez la rubrique « Utilisation de données audio » à la 
page 1203.
Une méthode simple pour rechercher et importer de la musique à partir de votre 
bibliothèque iTunes consiste à utiliser la catégorie Musique de la Bibliothèque Motion. 
Pour en savoir plus, voir « Ajout de fichiers iTunes et iPhoto à partir de la Bibliothèque » 
à la page 242.
Remarque : il est interdit d’importer des fichiers AAC soumis à des droits d’auteur, 
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Ajout de médias à votre projet
Une fois que vous avez créé un projet, l’étape suivante consiste à ajouter des fichiers 
de médias à votre composition. Tous les types de médias (plans de film, images fixes, 
fichiers audio ou autres objets figurant dans la Bibliothèque de Motion) sont ajoutés 
à votre projet à l’aide des mêmes méthodes. 
Remarque : les fichiers Photoshop multicouches comportent des options d’importation 
supplémentaires disponibles via le menu déroulant. Pour en savoir plus, voir « Ajout de 
fichiers Photoshop multicouches à un projet » à la page 241.
Lien entre les couches Motion et les fichiers de médias
Avant d’apprendre à ajouter des médias à votre projet Motion, il est important de comprendre le lien qui unit les couches et les médias source. Chaque fois que vous ajoutez 
un fichier à votre projet, vous créez un lien entre la couche affichée dans le Canevas 
et le fichier de média correspondant sur le disque dur.
Contrairement à certaines applications, comme iMovie HD, où les sections que vous 
supprimez des plans sont également supprimées du disque dur, Motion est une application non destructive application. Autrement dit, les modifications apportées aux objets 
de médias d’un projet Motion ne sont pas réellement appliquées aux fichiers de médias 
auxquels ils sont reliés.
En raison de ce lien, chaque fois que vous ajoutez un fichier à votre projet, vous devez 
vous assurer qu’il demeure disponible sur votre disque dur aussi longtemps que vous 
travaillez sur ce projet. Si vous déplacez, supprimez ou renommez des fichiers de médias 
correspondant aux couches d’un projet Motion, ces objets sont « déconnectés ». 
Les couches déconnectées apparaissent sous forme de rectangles en damier qui 
occupent la totalité du cadre de sélection entourant l’objet. 
Si le cas se présente, il est facile de reconnecter les couches déconnectées de votre 
projet à de nouvelles copies des médias que vous avez perdus, dans la mesure où 
ces fichiers sont toujours disponibles. Pour en savoir plus, voir « Comparaison entre 
les médias connectés et déconnectés » à la page 245.Chapitre 2 Création et gestion de projets 239
Sélection de fichiers dans le Navigateur
Vous pouvez ajouter des fichiers à un projet à l’aide du Navigateur ou de la commande 
Importer du menu Fichier. Le Navigateur constitue la méthode la plus commode dans 
la plupart des cas et vous apporte plus de contrôle sur la manière dont les objets apparaissent dans votre projet.
Avant d’ajouter des fichiers, vous devez d’abord les sélectionner dans le Navigateur. 
Vous pouvez ajouter des fichiers à un projet individuellement ou en groupe.
Pour sélectionner des fichiers dans le Navigateur :
1 Ouvrez le Navigateur.
2 Sélectionnez un ou plusieurs fichiers en procédant de l’une des manières suivantes :
Â Cliquez sur un seul fichier.
Â Maintenez la touche Maj ou Commande enfoncée, puis cliquez sur chaque fichier 
à sélectionner. 
Â Maintenez la touche Maj ou Commande enfoncée, puis cliquez sur tous les fichiers 
sélectionnés à désélectionner.
Â En présentation sous forme de liste, cliquez à gauche de la vignette d’un fichier 
quelconque, puis faites glisser le pointeur vers le haut ou vers le bas pour sélectionner plusieurs fichiers consécutifs.
Â En présentation sous forme de liste, maintenez la touche Maj enfoncée et utilisez 
les touches Flèches vers le haut et vers le bas pour ajouter des fichiers à la sélection 
actuelle.
Ajout de fichiers à votre projet
Les procédures suivantes s’appliquent à l’ajout de chaque type de fichier compatible 
avec Motion. 
Remarque : bien que les fichiers iTunes et iPhoto puissent être ajoutés à l’aide du 
Navigateur comme décrit ci-dessous, il est recommandé d’utiliser les catégories Musique et Photo dans la bibliothèque Motion. La bibliothèque vous permet de rechercher 
des fichiers à l’aide des fonctionnalités de liste de lecture ou d’album photo disponibles 
dans iTunes et iPhoto. Pour en savoir plus, voir « Ajout de fichiers iTunes et iPhoto à 
partir de la Bibliothèque » à la page 242.
Pour ajouter un ou plusieurs fichiers à un projet dans un nouveau groupe :
1 Si l’option « Créer couches à » de la sous-fenêtre Projet des préférences Motion est 
réglée sur « Sur l’image actuelle », déplacez la tête de lecture dans la Timeline jusqu’à 
l’image à partir de laquelle vous souhaitez que la première image du fichier commence.
Remarque : si l’option « Créer couches à » est réglée sur « Au début du projet », cette 
étape est inutile, car les fichiers importés sont toujours placés sur la première image.
2 Sélectionnez un ou plusieurs objets dans le Navigateur.240 Chapitre 2 Création et gestion de projets
3 Procédez de l’une des manières suivantes :
Â Faites glisser les fichiers sélectionnés dans le Canevas en les plaçant sur une position 
quelconque.
Â Cliquez sur le bouton Importer pour ajouter les fichiers sélectionnés au centre 
du Canevas.
Â Faites glisser les fichiers sélectionnés dans la zone vierge située en bas de l’onglet 
Couches.
Â Faites glisser les fichiers sélectionnés dans la zone vierge située en bas de la Timeline.
Â Choisissez Fichier > Importer (ou appuyez sur les touches Commande + I), sélectionnez 
un ou plusieurs fichiers dans la zone de dialogue Importation de fichiers, puis cliquez 
sur Ouvrir.
Un nouveau groupe est créé tout en haut de l’onglet Couches. Tous les fichiers apparaissent comme des couches imbriquées au sein de ce groupe. Dans la Timeline, 
le début de chaque nouvelle couche correspond à la position de la tête de lecture 
définie lors de l’étape 1.
Pour ajouter un ou plusieurs fichiers à un groupe existant:
1 Si l’option « Créer couches à » de la sous-fenêtre Projet des préférences Motion est 
réglée sur « Sur l’image actuelle », déplacez la tête de lecture dans la Timeline jusqu’à 
l’image à partir de laquelle vous souhaitez que la première image du fichier commence.
Remarque : si l’option « Créer couches à » est réglée sur « Au début du projet », cette 
étape est inutile, car les fichiers importés sont toujours placés sur la première image.
2 Ouvrez le Navigateur et l’onglet Couches.
3 Sélectionnez un ou plusieurs fichiers dans le Navigateur.
4 Pour imbriquer les fichiers sélectionnés sous un groupe existant, procédez de l’une 
des manières suivantes :
Â Faites glisser les fichiers sélectionnés sur n’importe quel groupe dans l’onglet Couches.
Les objets apparaissent imbriqués en haut de ce groupe d’objets.
Â Faites glisser les fichiers sélectionnés entre des objets du groupe.
Un indicateur de position signale la nouvelle position occupée par les objets dès que 
vous relâchez le bouton de la souris.
Â Faites glisser les fichiers sélectionnés dans la Timeline, en les plaçant entre des objets 
déjà imbriqués sous un groupe existant.
Remarque : pour en savoir plus sur la modification d’objets dans la Timeline, 
lisez la rubrique « Utilisation de la Timeline » à la page 353.
Une fois qu’un fichier a été ajouté à un projet, il apparaît comme une couche dans 
le Canevas, la Timeline, l’onglet Couches et l’onglet Média. Dans la Timeline, le début 
de chaque nouvelle couche correspond à la position de la tête de lecture définie lors 
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Vous pouvez également ajouter des fichiers à votre projet sans les faire apparaître dans 
la composition, en les faisant glisser directement dans l’onglet Média. Vous pouvez ainsi 
ajouter des objets que vous risquez d’utiliser plus tard, sans les placer réellement dans 
votre composition.
Pour ajouter un ou plusieurs fichiers à un projet sans les utiliser dans votre 
composition :
1 Ouvrez l’onglet Média.
2 Faites glisser un ou plusieurs fichiers du Navigateur dans l’onglet Média.
Ces objets de médias se sont pas affichés dans le Canevas, l’onglet Couches ni la Timeline. 
Ajout de fichiers Photoshop multicouches à un projet
Vous pouvez ajouter un fichier Photoshop multicouches à votre projet en le faisant 
glisser sur le Canevas, l’onglet Couches ou la Timeline, en cliquant sur le bouton Importer ou en choisissant la commande Importer. Si vous cliquez sur le bouton Importer 
(dans la zone de Preview), toutes les couches du fichier Photoshop sont par défaut 
réduites à une seule couche. Pour conserver les diverses couches du fichier importé, 
vous devez utiliser le menu déroulant ou la commande Fichier > Importer.
Pour contrôler l’ajout d’un fichier Photoshop multicouche à votre projet à l’aide 
du menu déroulant:
1 Faites glisser un fichier Photoshop à couches du Navigateur vers le Canevas, 
l’onglet Couches ou la Timeline.
2 Avant de relâcher le bouton de la souris, attendez un petit instant afin que le menu 
déroulant du Canevas s’ouvre.
Ce menu propose différentes commandes d’importation de fichier multicouche.
3 Faites glisser le fichier sur la commande voulue dans le menu déroulant, attendez 
que l’élément de menu se mette en surbrillance, puis relâchez le bouton de la souris.
Les couches du fichier Photoshop sont ajoutées à l’aide de la commande choisie.
Â Importer les couches fusionnées : toutes les couches du fichier Photoshop sont 
fusionnées en une seule couche.
Â Importer toutes les couches : un nouveau groupe est créé et imbriqué au sein 
du groupe actuellement sélectionné. Chaque couche du fichier Photoshop apparaît 
comme une couche distincte imbriquée au sein de ce groupe.
Vous pouvez également importer des couches individuelles à partir du fichier Photoshop. 
Chaque couche du fichier Photoshop sélectionné apparaît comme un élément distinct 
dans le menu déroulant. Si vous sélectionnez une couche particulière, seule cette couche 
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Remarque : lorsqu’un fichier Photoshop comporte plus de couches qu’il n’est possible 
d’afficher dans le menu déroulant, l’option Sélectionner une couche apparaît dans 
ce menu. Une fois cette option choisie, servez-vous de la zone de dialogue Sélectionnez 
la couche à importer pour sélectionner la couche à importer.
Pour contrôler la façon dont un fichier Photoshop est ajouté à votre projet à l’aide 
de la commande Importer :
1 Choisissez Fichier > Importer.
2 Sélectionnez le fichier à importer, puis cliquez sur Importer.
La zone de dialogue Sélectionnez la couche à importer.
3 Choisissez une commande dans le menu local Nom de la couche :
Â Couches fusionnées : toutes les couches du fichier Photoshop sont fusionnées 
en une seule couche.
Â Toutes les couches : un nouveau groupe est créé et imbriqué au sein du groupe 
actuellement sélectionné. Chaque couche du fichier Photoshop apparaît comme 
un objet distinct imbriqué au sein de ce groupe.
Â Couches individuelles : chaque couche du fichier Photoshop sélectionné apparaît 
comme un élément distinct dans le menu déroulant. Si vous sélectionnez une couche 
particulière, seule cette couche est ajoutée à votre projet, où elle apparaît comme 
un seul objet.
Pour changer la couche sélectionnée à l’origine pour l’importation, sélectionnez le fichier 
Photoshop dans la liste de couches, puis choisissez une couche dans le menu local 
Couche affiché par l’onglet Propriétés de l’Inspecteur.
Ajout de fichiers iTunes et iPhoto à partir de la Bibliothèque
Vous pouvez ajouter des fichiers à partir de vos bibliothèques iTunes et iPhoto à un projet 
via la Bibliothèque Motion. Cette possibilité est très pratique, car la bibliothèque et les 
listes de lecture iTunes, ainsi que les albums iPhoto, apparaissent dans les sous-catégories.
Remarque : bien qu’un iPod connecté apparaisse comme un disque dur dans le Navigateur, vous pouvez uniquement rechercher et importer les fichiers iPod stockés 
sous forme de données. La musique transférée vers l’iPod via iTunes ne peut pas être 
importée dans Motion.
Pour ajouter un fichier audio à partir d’iTunes :
1 Dans la Bibliothèque, sélectionnez la catégorie Musique.
La bibliothèque et les listes de lecture iTunes apparaissent. Par défaut, Tout est sélectionné 
(la bibliothèque iTunes).
2 Lorsque l’option Tout est sélectionnée, ou via la sélection d’une liste de lecture, 
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Remarque : lorsqu’elle est affichée en présentation par liste, la catégorie Musique affiche 
les informations Nom, Artiste, Album, Durée et Taille créées dans iTunes.
3 Procédez de l’une des manières suivantes :
Â Dans la zone d’aperçu, cliquez sur Appliquer.
Â Faites glisser le fichier audio vers le Canevas, la sous-fenêtre Projet ou la zone audio 
de la Timeline (et non l’Éditeur audio).
Remarque : les fichiers AAC avec protection des droits ne peuvent pas être importés 
dans Motion et n’apparaissent pas dans la pile de fichiers. Cela concerne toute la musique 
achetée dans la boutique iTunes.
Pour plus d’informations sur l’utilisation de fichiers audio, reportez-vous à la rubrique 
« Utilisation de données audio » à la page 1203.
Pour ajouter un fichier à partir d’iPhoto :
1 Dans la Bibliothèque, sélectionnez la catégorie Photos.
Les albums iPhoto apparaissent. Par défaut, Tout est sélectionné (la bibliothèque iPhoto).
2 Lorsque l’option Tout est sélectionnée, ou via la sélection d’un album, sélectionnez 
un fichier dans la pile.
Remarque : lorsqu’elle s’affiche en mode présentation par liste, la catégorie Photos 
affiche les informations créées dans iPhoto, telles que le Nom et la Taille du fichier.
3 Procédez de l’une des manières suivantes :
Â Dans la zone d’aperçu, cliquez sur Appliquer.
Â Faites glisser le fichier vers le Canevas, l’onglet Couches ou la Timeline.
Remarque : lors de l’importation d’images à grande échelle dans Motion, vous pouvez 
importer les fichiers tels quels, afin d’adapter les images à la taille du Canevas, ou de changer la résolution des images en fonction du Canevas. Pour en savoir plus, voir « Utilisation 
d’images fixes à haute résolution » à la page 228.
Gestion des couches de votre projet
Lorsque vous ajoutez un fichier à votre projet, une couche correspondante apparaît dans 
le Canevas, l’onglet Couches et la Timeline. Une fois cette couche ajoutée, vous pouvez 
la dupliquer dans le Canevas, l’onglet Couches et la Timeline pour créer autant de copies 
que nécessaire. Chaque copie créée dispose de ses propres paramètres dans l’Inspecteur, 
ce qui vous donne toute latitude pour modifier et animer individuellement chaque 
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Relation entre les objets affichés par les onglets Couches et Média
Chaque fichier que vous ajoutez à votre projet crée un objet correspondant dans 
l’onglet Média, même s’il est identique à d’autres fichiers que vous avez ajoutés. 
Cela signifie que si vous faites glisser cinq fois le même fichier dans votre projet 
à partir du Navigateur, cinq objets correspondants sont créés dans l’onglet Média.
Toutefois, si vous dupliquez une couche déjà présente dans votre projet, une relation 
est conservée entre cette nouvelle version de l’objet et l’objet préalablement affiché 
par l’onglet Média. Aucune nouvelle couche n’est créée dans l’onglet Média.
Par défaut, tous les objets ajoutés à votre projet sont automatiquement gérés par 
Motion. Si vous supprimez une couche du Canevas ou de la liste de couches, l’objet 
de média correspondant est automatiquement supprimé de l’onglet Média. Vous 
pouvez toutefois désactiver cette fonction dans la sous-fenêtre Générales des 
préférences Motion.
Duplication de fichiers
Si plusieurs copies d’un même objet sont nécessaires dans votre projet, vous pouvez 
soit les dupliquer directement dans le Canevas à l’aide de la commande Dupliquer, 
soit faire glisser un objet depuis l’onglet Média jusque dans le Canevas ou la Timeline 
pour créer une occurrence correspondante de cet objet. Vous pouvez également 
dupliquer un objet à l’aide de la commande Cloner la couche. Pour en savoir plus 
sur la commande Cloner la couche, voir « Clonage de couches » à la page 315.
Pour simplifier la gestion des couches dupliquées, utilisez les paramètres des objets de 
médias affichés dans l’onglet Média de l’Inspecteur. Ces paramètres définissent les propriétés essentielles de ces objets, telles que la fréquence d’images, les proportions pixel, 
l’entrelacement et le canal alpha. Il existe également des paramètres supplémentaires qui 
permettent de définir la condition de fin, l’inversion, le rognage et le contrôle du temps 
de chaque objet de média. Tous les paramètres d’un objet de média affecte l’ensemble 
des couches de votre projet qui ont une relation avec cet objet dans l’onglet Média, de 
sorte que la moindre modification de ces paramètres est répercutée simultanément sur 
chaque couche liée de votre projet.
Pour en savoir plus sur les paramètres des objets de médias dans l’onglet Média, 
voir « Paramètres d’objet disponibles dans l’onglet Média » à la page 250.Chapitre 2 Création et gestion de projets 245
Visualisation des liens entre les objets
Il existe deux paramètres d’objet qui permettent de visualiser la relation entre les objets 
de l’onglet Couches et les objets de l’onglet Média.
Â Le paramètre Média apparaît dans l’onglet Propriétés de l’Inspecteur chaque fois que 
vous sélectionnez un objet dans l’onglet Couches. Le paramètre Média est un cadre 
d’image qui affiche les données source de l’onglet Média auquel l’objet sélectionné 
correspond.
Â La liste Objets liés apparaît dans l’onglet Média de l’Inspecteur dès que vous sélectionnez 
un objet dans l’onglet Média. Cette liste présente tous les objets de l’onglet Couches 
qui correspondent aux données source sélectionnées. Le changement du nom d’un 
objet dans l’onglet Couches met automatiquement à jour le nom qui apparaît dans 
la liste Objets liés.
Utilisation de la commande Afficher le média source
Utilisez la commande Afficher le média source pour retrouver rapidement le média 
source de n’importe quelle couche dans l’onglet Média. 
Pour afficher le média source d’une couche sous l’onglet Média, procédez de 
l’une des manières suivantes :
m Cliquez sur une couche dans le Canevas, l’onglet Couches ou la Timeline tout en 
maintenant la touche Contrôle enfoncée, puis choisissez Afficher le média source 
dans le menu contextuel.
m Sélectionnez la couche, puis choisissez Objet > Afficher le média source (ou appuyez 
sur les touches Maj + F).
L’Inspecteur s’ouvre et affiche l’onglet Média. L’onglet Média de la sous-fenêtre Projet 
s’ouvre simultanément. Les données source sont sélectionnées et ses paramètres 
d’onglet Média sont affichés dans l’Inspecteur.
Comparaison entre les médias connectés et déconnectés
Comme indiqué précédemment, l’ajout d’une couche à un projet Motion crée un lien 
entre la couche de votre projet et le fichier de média correspondant sur le disque. Si vous 
supprimez, déplacez ou renommez des fichiers situés sur votre disque qui sont liés à des 
couches de Motion, ces fichiers sont « déconnectés », ce qui signifie qu’ils sont temporairement indisponibles pour votre projet. Ce cas peut également survenir si vous remettez 
un fichier de projet à quelqu’un sans lui remettre également les médias source utilisés.246 Chapitre 2 Création et gestion de projets
Lorsque vous ouvrez pour la première fois un fichier de projet comportant des fichiers 
de médias indisponibles, une zone de dialogue vous affiche la liste de tous les fichiers 
de médias introuvables. En partant de l’hypothèse que les médias n’ont pas été effacés, 
mais qu’ils ont été placés dans un autre dossier ou disque, vous disposez de l’option 
permettant de rechercher ces éléments dans tous les disques connectés à votre ordinateur. 
Si vous connaissez l’emplacement des médias manquants, vous pouvez afficher une zone 
de dialogue de reconnexion manuelle, afin d’accéder directement aux fichiers sans avoir 
à effectuer de recherche.
Pour reconnecter des fichiers de données de cette liste grâce au bouton Rechercher:
1 Cliquez sur Rechercher.
Motion tente automatiquement de retrouver le premier fichier manquant de la liste. 
S’il y parvient, une zone de dialogue apparaît avec le fichier de média manquant sélectionné. Dans le cas contraire, une zone de dialogue de reconnexion manuelle apparaît, 
afin que vous puissiez parcourir le disque à la recherche du fichier.
2 Dans la zone de dialogue de reconnexion manuelle, cliquez sur Ouvrir pour reconnecter 
le média.
Si un fichier a été renommé, vous devez effectuer une recherche manuelle.
3 Pour rechercher manuellement un fichier renommé, naviguez jusqu’à son emplacement, 
sélectionnez-le, puis cliquez sur Ouvrir.
Si plusieurs fichiers de médias manquants se trouvent dans le même dossier, 
tous les fichiers sont automatiquement reconnectés.Chapitre 2 Création et gestion de projets 247
Pour annuler une recherche active :
1 Cliquez sur Annuler.
La zone de dialogue de reconnexion manuelle apparaît alors.
2 Naviguez jusqu’à l’emplacement du fichier, puis cliquez sur Ouvrir.
Pour reconnecter les fichiers de données dans cette liste via la fonction Reconnecter :
1 Cliquez sur Reconnecter.
2 La zone de dialogue de reconnexion manuelle apparaît alors. Naviguez jusqu’à 
l’emplacement du fichier, puis cliquez sur Ouvrir.
Si une couche de votre fichier de projet est déconnectée et que vous ne la reconnectez 
pas immédiatement à l’ouverture du projet, elle est affichée sous la forme d’un rectangle 
en damier, qui occupe tout le cadre de sélection consacré à cette couche.
Si vous ne reconnectez pas immédiatement une couche déconnectée, vous pouvez 
toujours enregistrer les modifications apportées au projet et même le refermer, puis 
reconnecter les couches déconnectées plus tard. En fait, vous pouvez reconnecter 
des couches déconnectées à tout moment. 
Pour reconnecter une couche d’un projet avec son média source sur le disque :
1 Ouvrez l’onglet Média dans la sous-fenêtre Projet.
2 Sélectionnez la couche à reconnecter.
3 Ouvrez l’onglet Média dans l’Inspecteur.
4 Cliquez sur le bouton Remplacer le média situé sous le paramètre Objets liés.
Motion tente automatiquement de retrouver le premier fichier manquant de la liste. S’il 
parvient, une zone de dialogue apparaît avec le fichier de média manquant sélectionné. 
5 Cliquez sur Ouvrir pour le reconnecter. 248 Chapitre 2 Création et gestion de projets
Remarque : vous pouvez également utiliser la commande Fichier > Reconnecter les médias.
La couche déconnectée est à nouveau connectée et le graphisme d’origine apparaît. 
Si plusieurs fichiers de médias manquants se trouvent dans le même dossier, tous les 
fichiers sont automatiquement reconnectés. 
Suppression d’objets d’un projet
Il existe deux manières de supprimer un objet dans Motion. Vous pouvez supprimer 
une seule occurrence d’un objet en la supprimant dans l’onglet Couches, la Timeline 
ou le Canevas. Par défaut, cette méthode empêche l’utilisation de l’objet et supprime 
son média source de l’onglet Média, si ce dernier n’est plus utilisé par le projet. 
Si d’autres occurrences de cet objet figurent dans votre projet, elles sont conservées.
Vous pouvez également supprimer l’objet qui est affiché dans l’onglet Média. Cela permet 
de supprimer également toutes les occurrences correspondantes de cet objet dans 
votre projet.
Pour supprimer un ou plusieurs objets d’un projet :
1 Sélectionnez un ou plusieurs objets en procédant de l’une des manières suivantes :
Â Pour supprimer un seul objet, sélectionnez-le dans l’onglet Couches, la Timeline 
ou le Canevas.
Â Pour supprimer plusieurs objets, cliquez sur les objets tout en maintenant la touche 
Maj enfoncée.
Remarque : sous l’onglet Couches ou dans la Timeline, vous pouvez cliquer sur 
des objets non contigus tout en maintenant la touche Commande enfoncée afin 
de les sélectionner.
2 Pour supprimer les objets sélectionnés, procédez de l’une des manières suivantes :
Â Choisissez Édition > Supprimer.
Â Appuyez sur la touche Suppr.
Les objets sont supprimés de votre projet, mais leurs fichiers de médias sources stockés 
sur disque demeurent intacts.
Pour supprimer tous les objets correspondant à un seul objet dans l’onglet Média :
1 Ouvrez l’onglet Média, puis sélectionnez les données source à supprimer.
2 Procédez de l’une des manières suivantes :
Â Choisissez Édition > Supprimer.
Â Appuyez sur la touche Supprimer.
Une zone de dialogue vous invite à confirmer la suppression.
3 Cliquez sur Supprimer.Chapitre 2 Création et gestion de projets 249
Échange de médias dans un projet
Vous pouvez remplacer n’importe quelle couche de votre projet par un autre objet 
dans le Navigateur ou la Bibliothèque. Vous brisez alors le lien entre cette couche 
et son fichier source original, tout en créant un lien vers le fichier que vous utilisez en 
remplacement. Lorsque vous échangez le média source d’une couche de votre projet, 
elle conserve les valeurs de tous ses paramètres dans l’onglet Propriétés (tels que Position, 
Échelle et Opacité), le mode de fusion sélectionné, les filtres et les comportements 
imbriqués, les masques et les images clés.
L’opération d’échange vous permet de remplacer des couches de votre projet, même 
après les avoir modifiées et animées. Si vous n’êtes pas satisfait d’un élément particulier 
de votre composition, échangez-le avec un autre.
Important : vous ne pouvez échanger que des couches liées à des fichiers de médias 
sur disque. Vous ne pouvez pas échanger des objets générés par Motion, tels que 
les systèmes de particules, les générateurs ou les objets texte.
Cette opération vous permet d’utiliser des couches temporaires dans votre projet jusqu’à 
ce que les couches finalisées soient disponibles. Ainsi, si vous êtes en attente d’un dessin 
créé par un autre artiste, vous pouvez utiliser une image temporaire présentant les mêmes 
dimensions, puis l’échanger dès que le dessin final s’avère disponible.
Cette opération est extrêmement utile pour personnaliser des projets créés à l’aide 
de modèles. Pour en savoir plus, voir « Personnalisation de projets créés à partir de 
modèles » à la page 278.
Remarque : vous avez uniquement la possibilité d’échanger des couches individuelles 
dans l’onglet Couches. Il n’est pas possible d’échanger des objets dans l’onglet Média. 
Pour échanger une couche de votre projet dans l’onglet Couches :
1 Faites glisser un fichier depuis le Navigateur vers une couche de l’onglet Couches.
2 Dès que le pointeur courbe apparaît, relâchez le bouton de la souris.
La couche d’origine affichée par l’onglet Couches est remplacée par le nouvel objet.
Le pointeur courbe apparaît dès que vous 
faites glisser un nouvel objet sur la vignette 
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Pour remplacer une couche dans l’onglet Média :
1 Sélectionnez l’objet à remplacer dans l’onglet Média.
2 Dans l’Inspecteur, ouvrez l’onglet Média.
3 Cliquez sur Remplacer le média.
Une zone de dialogue s’ouvre.
4 Naviguez jusqu’au fichier à utiliser pour remplacer le média source actuel.
5 Cliquez sur Ouvrir.
Le nouvel objet de média remplace l’objet actuellement présent dans l’onglet Média, 
ainsi que toutes les couches ou tous les objets liés à cet objet de média dans votre projet.
Paramètres d’objet disponibles dans l’onglet Média
Si vous sélectionnez un objet dans l’onglet Média de la sous-fenêtre Projet, l’Inspecteur 
affiche un onglet Média contenant les propriétés définissant la manière dont l’objet 
apparaît dans Motion. Ces propriétés comprennent des paramètres tels que le type de 
canal alpha utilisé, les proportions pixel, l’ordre de trame, etc. Tous ces paramètres sont 
modifiables, ce qui permet de changer la manière dont l’objet est affiché et composé 
dans votre projet.
Bien que Motion tente toujours d’interpréter correctement la façon dont les objets 
que vous ajoutez à votre projet doivent être affichés, il est parfois impossible de savoir 
exactement comment traiter un fichier de médias source. Assurez-vous que chaque 
objet que vous ajoutez à votre projet est doté de réglages corrects dans l’onglet Média, 
afin de pouvoir mélanger et faire correspondre avec succès des objets présentant 
des proportions pixel, types de canal alpha et fréquence d’images différents.
Comme Motion est une application non destructive, les modifications apportées à ces 
paramètres ne sont pas appliquées aux fichiers de médias source sur disque. Elles n’ont 
une incidence que sur la manière dont les objets sont dessinés dans Motion.
Paramètres d’objet dans l’onglet Média
Les paramètres suivants permettent de contrôler les objets dans l’onglet Média, ce qui 
a également une incidence sur toutes les occurrences des objets dans le projet.
Type Alpha : le canal alpha d’un objet contient des informations qui définissent les 
zones de transparence de l’image ou du film. Si vous importez une séquence ou un 
fichier d’image QuickTime, son canal alpha est immédiatement reconnu par Motion. 
Il existe six méthodes différentes pour incorporer des informations de canal alpha dans 
des fichiers ; ces méthodes correspondent aux quatre options de ce menu local. Motion 
utilise automatiquement l’une de ces méthodes en fonction d’une analyse de l’objet 
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Les six commandes de ce menu local sont :
Â Aucun/Ignorer : réglage par défaut pour les objets dépourvus de canal alpha. 
Cette option permet également d’ignorer le canal alpha d’un objet, afin de rendre 
ce dernier complètement opaque.
Â Droit : les canaux alpha droits sont complètement séparés des canaux rouge, vert 
et bleu d’une image. Les fichiers de médias contenant des canaux alpha droits sont 
affichés de manière tout à fait normale dans une composition mais risquent de pré-
senter des anomalies s’ils sont affichés dans une autre application. Les effets translucides, tels que l’éclairage volumétrique ou les lumières parasites d’une image générée 
par ordinateur, peuvent sembler déformés tant que le plan n’est pas utilisé dans 
une composition. Si l’option Droit est choisie, mais que l’objet présente une frange 
noire, blanche ou colorée sur son contour, ce paramètre est mal réglé et doit être 
remplacé par l’une des options Prémultiplié, en fonction de la couleur de la frange.
Â Noir prémultiplié : ce type de canal alpha est multiplié avec les canaux rouge, vert 
et bleu du plan. Par conséquent, les objets contenant des canaux alpha prémultipliés 
sont toujours de bonne qualité, même s’ils ont des effets de lumière translucide, 
car l’image entière est pré-composée sur du noir. Cette option interprète des canaux 
alpha pré-composés sur du noir.
Â Blanc prémultiplié : cette option interprète des canaux alpha pré-composés 
sur du blanc.
Â Couleur prémultipliée : cette option interprète des canaux alpha pré-composés 
sur une autre couleur.
Â Détecter Type alpha : cette option force Motion à analyser le fichier afin de détecter 
automatiquement le type de canal alpha utilisé. En cas de doute, utilisez cette 
option.
Remarque : les fichiers PDF contenant des arrière-plans transparents ne disposent 
pas des paramètres Type Alpha ou Inverser alpha.
Remarque : les diverses couches d’un fichier Photoshop n’utilisent pas ces réglages. 
Ces paramètres sont uniquement utilisés si un fichier PSD est importé avec l’option 
« Couches fusionnées » activée. 
Inverser alpha : un canal alpha est généralement un canal de niveaux de gris où le blanc 
représente les zones dont l’opacité est de 100 pour cent (zones opaques), le gris repré-
sente les zones partiellement opaques et le noir représente les zones dont l’opacité 
est de 0 pour cent (zones transparentes). Cette case permet d’inverser un canal alpha 
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Proportions pixel : détermine si l’objet a été créé à l’aide de pixels carrés ou non carrés. 
En général, les objets créés pour les écrans d’ordinateur, les films et la vidéo à haute 
définition utilisent des pixels carrés, tandis que les objets créés pour les formats vidéo à 
définition standard utilisent des pixels non carrés. Un champ situé à droite de ce menu 
local affiche les valeurs de proportions pixel afin que vous puissiez éventuellement les 
modifier manuellement. En identifiant correctement chaque objet que vous ajoutez à 
votre projet, vous pouvez mélanger et faire correspondre les deux types de médias.
Ordre de trame : lorsque vous importez de la vidéo entrelacée, choisissez l’ordre de 
trame utilisé pour la capture des plans. Elle doit correspondre à l’ordre de trame du 
périphérique utilisé pour la capture. L’entrelacement peut être Supérieure (impaire) 
ou Inférieure (paire). Un choix incorrect se traduit immédiatement, lors de la lecture, 
par une vidéo « saccadée », car l’ordre des trames est accidentellement inversé. Dans 
ce cas, choisissez simplement l’ordre de trame inverse via ce menu local. Les plans filmés sur pellicule ou à l’aide d’une caméra vidéo à balayage progressif ne sont pas 
entrelacés et doivent être réglés sur Aucune. En identifiant correctement chaque objet 
de votre projet, vous pouvez mélanger et faire correspondre des plans présentant des 
ordres de trame différentes.
Fréquence d’images : choisissez une fréquence en images par seconde, correspondant 
à la fréquence native du plan. Pour les films, cette fréquence est de 24 ips ; pour la vidéo 
PAL, elle est de 25 ips et pour la vidéo NTSC de 29,97 ips. D’autres fréquences d’images 
sont disponibles pour différents formats vidéo. Si la fréquence d’images requise ne figure 
pas dans la liste, vous pouvez taper un nombre dans le champ de texte situé à droite du 
menu local.
Remarque : les fréquences d’images du projet sont déterminées par le préréglage 
du projet. Pour modifier un préréglage ou en créer un, choisissez Motion > Préférences 
et utilisez les options de la sous-fenêtre Préréglages.
Si vous modifiez la fréquence d’images d’un fichier QuickTime, vous pouvez choisir 
Depuis le fichier, en bas du menu local Fréquence d’images, pour attribuer à ce paramètre la fréquence d’images du fichier QuickTime d’origine.
Remarque : bien que vous ayez toute latitude pour mixer des plans utilisant diverses 
fréquences d’images, les plans lus à une fréquence différente de celle du projet risquent 
de provoquer des problèmes lors de leur lecture.
Rognage : paramètre multidimensionnel qui définit un nombre de pixels à supprimer 
sur chacun des quatre côtés d’un objet, par rapport au bord extérieur de la zone entourant l’objet. Le rognage d’un objet dans l’onglet Média entraîne le rognage de toutes 
les occurrences de cet objet qui figurent dans votre projet. Un paramètre de rognage 
similaire, disponible pour les objets de l’onglet Couches, vous permet de rogner individuellement chaque occurrence de cet objet. Pour en savoir plus, voir « Paramètres disponibles dans l’onglet Propriétés » à la page 312.Chapitre 2 Création et gestion de projets 253
Contrôle du temps : ces paramètres contrôlent le début, la fin et la durée de chaque 
objet de média.
Â Entrée : détermine le point d’entrée de l’objet, aussi bien en vitesse constante que 
variable. Le réglage de ce paramètre déplace toujours le point d’entrée de l’objet 
vers l’image indiquée, sans pour autant affecter sa durée.
Â Sortie : détermine le point de sortie de l’objet, aussi bien en vitesse constante que 
variable. Le réglage de ce paramètre déplace toujours le point de sortie de l’objet 
vers l’image indiquée, sans pour autant affecter sa durée.
Â Durée : détermine la durée totale de l’objet. Si Time Remap est réglé sur Vitesse 
constante, le réglage de la Durée affecte également la Vitesse et le Point de sortie. 
En revanche, si Time Remap est réglé sur Vitesse variable, le réglage de la Durée 
n’affecte en rien la lecture à vitesse variable.
Objets liés : cette liste présente tous les objets de l’onglet Couches qui sont liés à 
cet objet. Deux colonnes affichent le nom de chaque couche contenant une instance 
des données source, ainsi que le nom de l’objet. Toute modification du nom d’un objet 
dans l’onglet Couches est automatiquement répercutée sur le nom qui figure dans 
la liste Objets liés de l’objet correspondant.
Bouton Remplacer le média : ce bouton permet de reconnecter un objet de média 
de votre projet à un autre fichier source sur disque. Cette fonction est principalement 
utilisée pour reconnecter des objets déconnectés, mais elle peut également être utilisée pour remplacer le média utilisé par un objet de votre projet par un autre média. 
Il vous permet également de remplacer un objet par un autre, en même temps que 
toutes les occurrences de cet objet dans votre projet.
Résumé : sous-fenêtre distincte qui affiche les propriétés du fichier de données 
du disque, lié à l’objet sélectionné.254 Chapitre 2 Création et gestion de projets
Utilisation des médias de la Bibliothèque
Motion est fourni avec une collection de médias et d’objets d’effets que vous pouvez 
utiliser dans vos projets. La Bibliothèque partage de nombreuses commandes et fenêtres 
avec le Navigateur. Ces deux onglets sont conçus pour naviguer à travers les médias 
que vous souhaitez ajouter à votre projet. Toutes les commandes de la Bibliothèque 
fonctionnent généralement comme celles du Navigateur, mais la manière d’organiser 
la liste des médias est différente.
La barre latérale de la Bibliothèque est remplacée par une sous-fenêtre à deux colonnes. 
La colonne de gauche affiche toutes les catégories de médias et d’effets disponibles 
dans la Bibliothèque. Lorsque vous sélectionnez une catégorie, des sous-catégories 
apparaissent dans la colonne de droite. La sélection d’une sous-catégorie affiche tous 
les médias ou les objets d’effets de cette sous-catégorie dans la pile de la Bibliothèque 
située en dessous.
Les sections suivantes décrivent les catégories disponibles dans la Bibliothèque.
Comportements et filtres
Les comportements et les filtres sont appliqués directement aux objets qui ont été 
ajoutés à votre projet. Ils n’ont pas d’existence propre. Ils doivent être associés à un 
objet ou une couche pour produire un effet. Il est possible de personnaliser les comportements et les filtres après les avoir ajoutés à un projet ; les versions personnalisées 
peuvent être stockées dans la Bibliothèque en vue d’une utilisation future. 
Pour en savoir plus sur les comportements, lisez la rubrique « Utilisation des 
comportements » à la page 405. Pour en savoir plus sur les filtres, lisez la rubrique 
« Utilisation des filtres » à la page 909.
Filtres de tierce partie
Les filtres de tierce partie installés sur votre ordinateur apparaissent, prêts à l’emploi, 
dans cette catégorie.
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Images (filtres)
Cette catégorie Images apparaît dans la Bibliothèque Motion si vous utilisez Mac OS X 10.4 
ou toute version ultérieure. Motion prend en charge les filtres d’imagerie Core 
du système d’exploitation. 
Générateurs
Les générateurs sont des objets créés par l’ordinateur et que l’utilisateur peut personnaliser, 
qui peuvent être utilisés pour créer divers éléments graphiques. Lorsque vous ajoutez 
un générateur à votre projet, il s’adapte automatiquement aux dimensions d’image et 
à la fréquence d’images du projet. Les générateurs possèdent une durée infinie et peuvent 
donc être lus aussi longtemps que nécessaire. 
Les générateurs possèdent tous les paramètres de propriété appartenant aux autres 
objets. Les propriétés spécifiques de chaque générateur sont également affichées 
dans l’onglet Générateur de l’Inspecteur chaque fois qu’un générateur est sélectionné. 
Vous pouvez également enregistrer des versions personnalisées de générateurs dans 
la Bibliothèque afin de les utiliser plus tard. 
Pour en savoir plus sur les générateurs disponibles dans Motion, lisez la rubrique 
« Utilisation de générateurs » à la page 1037.
Images (générateurs)
Cette catégorie Images apparaît dans la Bibliothèque Motion si vous utilisez Mac OS X 10.4 
ou toute version ultérieure. Motion prend en charge les générateurs d’imagerie Core 
du système d’exploitation. 
Émetteurs de particules
Plusieurs catégories d’émetteurs de particules préfabriqués vous permettent d’ajouter 
rapidement des effets allant de simulations de fumée, de feu et d’explosions à des textures animées abstraites utilisables de diverses manières. Tous les systèmes de particules 
prédéfinis de Motion peuvent être personnalisés une fois que vous les avez ajoutés 
à votre projet.
Pour en savoir plus sur l’utilisation des systèmes de particules, lisez la rubrique « Utilisation 
des particules » à la page 743.
Réplicateurs
Plusieurs catégories de réplicateurs prédéfinis permettent d’ajouter rapidement 
des motifs animés d’arrière-plan, de transition ou autres. Tous les réplicateurs prédéfinis 
de Motion peuvent être personnalisés une fois que vous les avez ajoutés à votre projet.
Pour plus d’informations sur l’utilisation du réplicateur, consultez la rubrique « Utilisation 
du Réplicateur » à la page 815.256 Chapitre 2 Création et gestion de projets
Formes
Cette catégorie contient des formes préfabriquées que vous pouvez utiliser comme 
éléments visuels ou comme masques d’images. Chacune est en fait une forme de Bézier 
qui peut être personnalisée à l’aide des outils de modification de forme de Motion. Pour 
en savoir plus sur la modification des formes et des masques, lisez la rubrique 
« Utilisation des formes et des masques » à la page 1071.
Dégradés
La catégorie Dégradés contient des préréglages de dégradé que vous pouvez utiliser 
dans l’éditeur de dégradé qui se trouve dans les émetteurs et les cellules des systèmes de 
particules, ainsi que dans les objets texte et les formes. Motion est fourni avec une collection de préréglages de dégradé, mais vous pouvez également enregistrer vos dégradés 
personnalisés créés à l’aide de n’importe quel Éditeur de dégradés.
Polices et polices LiveFonts
Ces catégories contiennent les polices et les polices LiveFonts installées sur votre 
ordinateur. Les polices sont réparties en sous-catégories, en fonction des catégories 
de polices définies dans l’application Livre des polices. Pour en savoir plus sur le Livre 
des polices, consultez l’Aide Mac, disponible dans le menu Aide du Finder.
Vous pouvez utiliser les catégories de polices pour afficher un Preview des polices 
disponibles sur votre ordinateur. Vous pouvez également faire glisser des polices et des 
polices LiveFonts sur des objets texte pour modifier le style qu’ils utilisent. Pour en savoir 
plus sur l’utilisation des polices avec les objets texte, lisez la rubrique « Utilisation de la 
zone de Preview des polices dans la Bibliothèque » à la page 627.
Styles de texte
Les styles de texte sont des préréglages applicables aux objets texte de votre projet 
afin de modifier instantanément leurs paramètres de style. Ces paramètres comprennent 
la face, la structure, l’éclat et l’ombre portée. Faire glisser un style de texte sur un objet 
texte permet d’appliquer instantanément ce style au texte concerné.
Pour en savoir plus sur les styles de texte, lisez la rubrique « Modification du style de 
texte » à la page 641.
Styles de forme
Les styles de forme sont des préréglages applicables aux formes et aux traits de peinture 
de votre projet afin de modifier instantanément leurs paramètres de style. Faire glisser 
un style de forme sur une forme permet d’appliquer instantanément ce style à la forme 
concernée.
Pour en savoir plus sur les styles de forme, voir « Enregistrement de formes et de styles 
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Musique et photos
Ces catégories permettent de rechercher et d’importer des fichiers audio directement 
à partir de votre bibliothèque iTunes, ainsi que des fichiers image directement à partir 
de votre bibliothèque iPhoto. Les sous-catégories Musique de Motion incluent la bibliothèque et les éventuelles listes de lecture créées dans iTunes. Les sous-catégories Photos 
sont des albums créés dans iPhoto. Le contenu de chaque bibliothèque, album ou liste 
de lecture apparaît dans la pile de fichiers.
Pour en savoir plus sur l’importation de fichiers iPhoto ou iTunes, consultez la rubrique 
« Ajout de fichiers iTunes et iPhoto à partir de la Bibliothèque » à la page 242.
Contenu
Motion est fourni avec une collection d’éléments graphiques préfabriqués et d’objets 
générés par Motion qui apparaissent dans la catégorie Contenu. Vous pouvez glisserdéposer tous ces objets sur le Canevas et les utiliser comme des éléments de conception 
dans votre propre projet. Certaines des sous-catégories contiennent des objets utilisés 
pour créer les modèles inclus dans Motion. La seule exception concerne la sous-catégorie 
Images de particules, qui comprend les sources de cellules de particules utilisées pour 
générer les préréglages des émetteurs de particules inclus dans Motion.
Par défaut, les fichiers de contenu livrés avec Motion sont enregistrés dans le dossier 
/Bibliothèque/Application Support/Final Cut Studio/Motion lors de l’installation de Motion. 
Au cours de l’installation, vous pouvez sélectionner un autre emplacement pour installer 
le contenu Motion. Les objets Motion personnalisés placés dans la Bibliothèque sont 
enregistrés dans le dossier /Utilisateurs/nom d’utilisateur/Bibliothèque/Application 
Support/Final Cut Studio/Motion/Bibliothèque/Content.
Remarque : le fait de faire glisser un objet média dans la catégorie Contenu ne modifie 
pas l’emplacement original du fichier correspondant sur le disque. Il est dès lors recommandé de centraliser tous les médias que vous comptez importer dans la Bibliothèque 
dans leur propre emplacement sur le disque, afin d’éviter tout déplacement, modification 
de nom ou suppression accidentels de ces fichiers.
Favoris et Menu Favoris
Il est facile de personnaliser les comportements, filtres, systèmes de particules, dégradés 
et générateurs utilisés dans Motion afin de créer vos propres effets. Ces objets personnalisés sont enregistrés dans les catégories correspondantes. La catégorie Favoris offre 
un emplacement pour les objets (intégrés ou personnalisés) que vous utilisez fréquemment. Vous pouvez également y placer des fichiers de médias fréquemment utilisés, 
tels que les fichiers PDF ou TIFF. Les objets placés dans la catégorie Favoris sont disponibles pour tous les projets que vous créez dans Motion.258 Chapitre 2 Création et gestion de projets
Les objets que vous placez dans le dossier Menu Favoris apparaissent dans le menu 
Favoris, ce qui vous permet d’y accéder encore plus rapidement. Lorsque vous choisissez 
un élément dans le menu Favoris, il est placé dans la couche sélectionnée et positionnée 
au centre du Canevas. Les objets placés dans le menu Favoris sont disponibles pour 
tous les projets que vous créez dans Motion.
Les objets que vous faites glisser dans les catégories Favoris et Menu Favoris sont respectivement enregistrés dans les dossiers /Utilisateurs/nom d’utilisateur/Bibliothèque/
Application Support/Final Cut Studio/Motion/Bibliothèque/Favoris et /Menu Favoris.
Remarque : les objets placés dans des sous-catégories correspondant à un dossier situé 
dans /Bibliothèque/Application Support/Final Cut Studio/Motion/Favoris sont partagés 
par tous les comptes utilisateur inscrits sur cet ordinateur.
Ajout de votre propre contenu à la Bibliothèque
Vous pouvez ajouter vos versions personnalisées de générateurs, filtres, comportements 
et dégradés aux catégories de la Bibliothèque. De plus, si vous travaillez sur un ou plusieurs programmes où les mêmes éléments graphiques sont fréquemment réutilisés 
ou si vous disposez d’une bibliothèque d’éléments graphiques utilisés régulièrement, 
vous pouvez ajouter ces fichiers de médias à la catégorie Favoris. Il est recommandé 
d’ajouter tout contenu personnalisé à la catégorie Favoris. En effet, le contenu que 
vous placez dans la Bibliothèque est disponible pour tous les projets de Motion. 
Pour ajouter des objets générés par Motion à une catégorie Contenu :
m Faites glisser un objet soit dans le dossier Favoris de la liste des catégories ou des 
sous-catégories de la Bibliothèque, soit directement dans la pile de la Bibliothèque.
Important : chaque catégorie (à l’exception des catégories Contenu, Favoris et Menu 
Favoris) est filtrée en fonction du type d’objet qu’elle représente. Vous pouvez par exemple placer un filtre personnalisé par un utilisateur dans la catégorie Filtres, mais vous ne 
pouvez pas placer un filtre dans la catégorie Comportements.Chapitre 2 Création et gestion de projets 259
Vous pouvez également placer des fichiers de médias du disque dans la catégorie 
Contenu, Favoris et Menu Favoris.
Pour ajouter un objet de média à la catégorie Favoris :
m Depuis l’onglet Couches, l’onglet Média ou le Navigateur, faites glisser un objet de média 
vers le dossier Favoris de la Bibliothèque.
Lorsque vous ajoutez votre propre contenu, vous pouvez créer des dossiers supplé-
mentaires afin d’ajouter des sous-catégories à la colonne des sous-catégories.
Pour créer une sous-catégorie dans n’importe quelle catégorie :
1 Ouvrez la Bibliothèque, puis sélectionnez une catégorie.
2 Cliquez sur le bouton Nouveau dossier (+) qui se trouve en bas de la Bibliothèque.
3 Renommez le nouveau dossier comme vous le souhaitez.
Ce nouveau dossier apparaît dans la colonne des sous-catégories chaque fois 
qu’une catégorie est sélectionnée.
Pour supprimer des objets ou des dossiers d’une catégorie Contenu :
m Sélectionnez un objet ou un dossier dans la pile de la Bibliothèque, puis procédez 
de l’une des manières suivantes :
Â Choisissez Édition > Supprimer.
Â Appuyez simultanément sur les touches Commande + Supprimer.
Utilisation d’objets personnalisés depuis la Bibliothèque
Lorsque vous faites glisser un objet personnalisé de la Bibliothèque vers le Canevas, 
le centre de cet objet est déposé à l’emplacement où vous avez relâché le bouton 
de la souris. En revanche, si vous cliquez sur le bouton Appliquer dans la zone de 
Preview pour ajouter cet objet, il est ajouté au centre du Canevas.
Si vous faites glisser vers le Canevas des objets qui ont été enregistrés avec l’option 
« Tous dans un fichier » activée dans le menu déroulant, ces objets sont déposés 
à l’emplacement où vous avez relâché le bouton de la souris, puis positionnés selon 
leur disposition d’origine au moment de leur enregistrement dans la Bibliothèque. 
En revanche, si vous cliquez sur le bouton Appliquer dans la zone de Preview pour 
ajouter ces objets, ils sont ajoutés au centre du Canevas.
Remarque : si vous faites glisser un masque personnalisé depuis la Bibliothèque 
vers un projet, il conserve la position dans laquelle il a été enregistré (par rapport 
à l’image ou à la séquence sur laquelle il est déposé).260 Chapitre 2 Création et gestion de projets
Médias de la Bibliothèque indisponibles
Comme pour tout autre objet utilisé dans un projet Motion, la Bibliothèque de médias 
utilisée par un projet doit être présente et installée sur l’ordinateur actuel pour que ces 
objets apparaissent correctement dans Motion. Si quelqu’un vous transmet un fichier 
de projet et que vous ne disposez pas des mêmes filtres, polices ou polices LiveFonts 
que vous, un message d’avertissement s’affiche à l’ouverture du projet et présente 
la liste des éléments indisponibles.
Vous pouvez soit fermer le projet et installer les fichiers nécessaires sur votre ordinateur, 
soit poursuivre votre travail et ouvrir le fichier. La liste qui suit résume ce qui se passe 
lorsque vous ouvrez un fichier de projet sans disposer des médias nécessaires :
Contenu manquant : le contenu manquant est traité comme tout autre objet de médias 
manquant. Les objets deviennent offline et vous pouvez à tout moment choisir de 
les reconnecter.
Filtres manquants : si un ou plusieurs filtres sont manquants, les objets de votre projet 
qui utilisent ces filtres sont affichés avec un emplacement signalant quel est le filtre 
manquant. Cela vous permet de réinstaller le filtre plus tard.
Polices manquantes : lorsque des polices sont manquantes, les objets texte qui utilisent 
ces polices adoptent par défaut la police de remplacement temporaire Geneva. 
Les polices internationales manquantes sont remplacées par la police système 
par défaut correspondant à la langue concernée.
Polices LiveFonts manquantes : si des polices LiveFonts sont manquantes, la police 
LiveFont utilisée précédemment est remplacée par une autre police LiveFont installée 
sur votre ordinateur.
Organisation des groupes et des couches dans Motion
Chaque fois que vous faites glisser un fichier de média depuis la Bibliothèque ou le 
Navigateur vers le Canevas, l’onglet Couches ou la Timeline ou que vous générez une 
image dans Motion, l’élément obtenu est représenté par une couche. Imaginez les couches 
comme des transparents placés les uns au-dessus des autres. Toutes les couches se 
combinent pour créer l’image qui apparaît dans le Canevas. Motion met à votre disposition 
une représentation graphique de cette hiérarchie de couches dans l’onglet Couches 
de la sous-fenêtre Projet, ainsi que dans la liste de couches de la Timeline. Vous pouvez 
réorganiser l’ordre d’empilement des couches en les faisant glisser à un autre emplacement dans ces deux listes.Chapitre 2 Création et gestion de projets 261
À leur tour, les couches sont imbriquées dans des conteneurs appelés des groupes. 
Dès que vous créez une couche, elle est placée au sein d’un groupe. Vous pouvez faire 
glisser les couches d’un groupe à l’autre, mais elles ne peuvent exister seules en dehors 
d’un groupe. Les couches imbriquées dans un groupe sont affichées en retrait dans 
l’onglet Couches et la liste de couches de la Timeline.
Un groupe peut également contenir d’autres groupes imbriqués. Vous pouvez ainsi 
élaborer des hiérarchies complexes de groupes imbriqués, chacun étant subordonné 
au groupe qui le contient et ce, jusqu’au groupe de niveau supérieur.
L’organisation des couches d’un projet a pour objectif majeur de vous permettre de 
regrouper toutes les couches sur lesquelles vous travaillez en une seule unité. Vous avez 
ainsi la garantie que les animations et les effets appliqués au groupe d’imbrication 
affectent toutes les couches imbriquées au sein de ce groupe. En imbriquant toutes 
les couches que vous souhaitez animer dans un seul groupe, vous gagnez du temps, 
car il vous suffit d’animer ce groupe, plutôt que chacune des couches qu’il contient.
Objets imbriqués
Groupe d’imbrication
Groupes imbriqués
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Par exemple, lorsque vous sélectionnez un groupe contenant trois couches imbriquées, 
l’intégralité du groupe est sélectionnée comme une seule unité.
Tout déplacement de la sélection dans le Canevas permet de déplacer les trois couches 
simultanément.
Quelle que soit la manière dont elles sont imbriquées, les couches peuvent toujours 
être animées indépendamment l’une de l’autre. Il est donc possible d’animer séparément 
des groupes subordonnés, tout en gardant à l’esprit que l’animation et les effets qui 
leur sont appliqués affectent tous les groupes et les couches imbriqués en dessous.
Liste des couches avec un groupe sélectionné Groupe sélectionné
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L’exemple suivant décrit la création d’une hiérarchie de groupes en vue de préparer 
l’animation d’un personnage. Chaque composant du personnage est contenu dans 
une couche séparée. Son bras, par exemple, est formé par des couches correspondant 
à la main, au bras et à l’avant-bras. Chaque couche associée est placée dans un groupe 
imbriqué dans un groupe parent. Pour le bras, la main est imbriquée dans le groupe 
de l’avant-bras, qui est à son tour imbriqué dans le groupe du bras.
Remarque : dans cet exemple, chaque point d’ancrage d’un objet est placé à un endroit 
correspondant approximativement à l’axe de rotation de cet objet. Pour en savoir plus 
sur le changement du point d’ancrage d’un objet, lisez la rubrique « Modification du 
point d’ancrage d’un objet » à la page 305.264 Chapitre 2 Création et gestion de projets
Les deux bras et les deux jambes sont également constitués d’une hiérarchie de parties 
du corps imbriquées. Par la suite, ces deux groupes imbriqués de couches, qui sont 
connectés au torse, sont eux-mêmes imbriqués dans le groupe du mannequin. 
La réduction des hiérarchies du bras et de la jambe permet de faire apparaître 
la hiérarchie simplifiée suivante.
En organisant tous ces objets de cette manière, l’animation du personnage devient 
chose aisée. Pour déplacer l’ensemble du bras, il vous suffit donc de sélectionner le groupe 
du bras gauche, quel que soit le nombre de couches imbriquées dans ce groupe.
Imbrication de groupes pour simplifier un projet
Sélection du groupe du bras gauche pour sélectionner 
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Lorsque vous faites pivoter la sélection dans le Canevas, tous les objets imbriqués dans 
le groupe pivotent comme s’il s’agissait d’un seul élément.
L’application de filtres et de comportements offre un autre exemple de l’intérêt 
des hiérarchies de groupes. Si vous appliquez un filtre à une seule couche d’un groupe, 
il n’affecte que cette couche. Les autres couches du groupe ne sont pas modifiées.
Avant la rotation du groupe du bras gauche Après la rotation du groupe du bras gauche
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Toutefois, si vous appliquez directement le même filtre au groupe, toutes les couches 
imbriquées dans ce groupe sont affectées par le filtre, comme si elles constituaient 
une seule couche.
Arrière-plan de votre projet
La zone de dialogue Propriétés du projet (accessible en choisissant Édition > Propriétés 
du projet) comporte deux paramètres qui ont une incidence sur la couleur d’arrière-plan 
de votre projet et l’apparence de votre composition lors de son exportation à partir 
de Motion :
Couleur d’arrière-plan : cadre de couleurs vous permettant de déterminer la couleur 
affichée dans le Canevas si aucun autre objet n’est présent à l’avant-plan.
Remarque : si vous comptez exporter votre projet avec un canal alpha prémultiplié, 
sachez que Motion effectue toujours le rendu sur du noir.
Arrière-plan : menu local qui définit si le rendu de la couleur d’arrière-plan doit être 
effectué comme une partie du canal alpha. Si vous choisissez Uni, la couleur d’arrièreplan génère un canal alpha opaque. En revanche, si vous choisissez Transparent, le 
rendu de la couleur d’arrière-plan n’est pas obtenu comme une partie du canal alpha. 
Quel que soit votre choix, la couleur d’arrière-plan est affichée dans le Canevas.
Sélection de couches et de groupes dans l’onglet Couches
Pour réorganiser des couches et des groupes d’un projet, vous devez tout d’abord 
les sélectionner. Cette section traite des nombreuses méthodes que vous pouvez 
utiliser pour sélectionner des couches dans l’onglet Couches.
Pour sélectionner une seule couche ou un seul groupe :
m Cliquez sur une couche ou un groupe dans l’onglet Couches.
Ce faisant, vous désélectionnez tous les autres objets sélectionnés.
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Remarque : la sélection d’un groupe n’entraîne pas la sélection des couches imbriquées 
en dessous. En revanche, les opérations effectuées sur un groupe sélectionné affectent 
également toutes les couches imbriquées dans ce groupe.
Pour sélectionner plusieurs couches ou groupes contigus, procédez de l’une 
des manières suivantes :
m Cliquez sur deux couches quelconques de la liste de couches tout en maintenant 
la touche Maj enfoncée.
Vous sélectionnez alors ces deux couches, ainsi que toutes les couches situées au milieu. 
m Cliquez à gauche de la vignette d’une couche quelconque, puis faites glisser le pointeur 
vers le haut ou vers le bas pour sélectionner plusieurs couches.
Pour sélectionner/désélectionner plusieurs couches ou groupes non contigus, 
procédez de l’une des manières suivantes :
m Cliquez sur une couche ou un groupe non sélectionné tout en maintenant la touche 
Commande enfoncée, afin de l’ajouter à la sélection.
m Cliquez sur une couche ou un groupe sélectionné tout en maintenant la touche 
Commande enfoncée pour le désélectionner.
Pour sélectionner l’ensemble des couches ou des groupes de l’onglet Couches, 
procédez de l’une des manières suivantes :
m Choisissez Édition > Tout sélectionner (ou appuyez sur les touches Commande + A).
m Cliquez sur le groupe ou la couche situé tout en haut de la liste, appuyez sur la touche 
Maj et maintenez-la enfoncée, puis cliquez sur le groupe ou la couche situé tout en bas.
Pour désélectionner tous les objets ou groupes de l’onglet Couches :
m Choisissez Édition > Tout désélectionner (ou appuyez sur les touches Maj + Commande + A).
Réorganisation dans l’onglet Couches
L’ordre dans lequel les couches et les groupes apparaissent dans l’onglet Couches 
détermine la présentation de l’ensemble de votre projet. En effet, cet ordre définit 
l’affichage des objets les uns par rapport aux autres dans le Canevas. Vous pouvez 
modifier l’ordre d’un ou de plusieurs objets dans le Canevas ou l’onglet Couches.
Pour avancer ou reculer une couche ou un groupe dans l’onglet Couches :
m Faites glisser une couche ou un groupe vers le haut ou le bas de la liste de couches. 
Un indicateur de position est affiché pour montrer la nouvelle place occupée par 
la sélection si vous relâchez le bouton de la souris.
Remarque : vous pouvez également utiliser les commandes Avancer et Reculer du 
menu Objet, pour faire monter ou descendre les couches dans la hiérarchie imbriquée 
de n’importe quel groupe. Ces commandes sont particulièrement utiles si vous travaillez 
avec des objets sélectionnés directement dans le Canevas. Pour en savoir plus, 
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Si vous souhaitez organiser les objets de votre projet en plusieurs groupes, vous pouvez 
à tout moment créer de nouveaux groupes vides.
Pour créer un nouveau groupe vide, procédez de l’une des manières suivantes :
m Cliquez sur le bouton Ajouter (+) situé en haut de l’onglet Couches.
m Choisissez Objet > Nouveau groupe (ou appuyez sur les touches Maj + Commande + N).
Les nouveaux groupes apparaissent toujours en haut de l’onglet Couches. Ils sont 
numérotés en fonction du nombre de groupes que vous avez créés jusqu’à présent.
Lorsque vous disposez de plusieurs groupes, vous pouvez déplacer les couches d’un 
groupe à l’autre, modifiant ainsi leurs relations d’imbrication au sein de votre projet.
Pour déplacer une couche d’un groupe vers un autre :
1 Sélectionnez une ou plusieurs couches.
2 Procédez de l’une des manières suivantes :
Â Faites glisser les couches sélectionnées vers un nouvel emplacement sous un 
autre groupe.
Un indicateur de position est affiché pour montrer la nouvelle place occupée par 
la sélection si vous relâchez le bouton de la souris. Si vous faites glisser les couches 
sélectionnées au sein d’un groupe imbriqué, la longueur de l’indicateur de position 
signale la position occupée par la sélection au sein de la hiérarchie du groupe.
Â Sélectionnez une ou plusieurs couches, puis choisissez Édition > Couper (ou appuyez 
sur les touches Commande + X). Sélectionnez ensuite le groupe au sein duquel 
vous souhaitez les coller, puis choisissez Édition > Coller (ou appuyez sur les touches 
Commande + V).
Vous pouvez également copier une couche d’un groupe à un autre.
Pour copier une couche d’un groupe à un autre, procédez de l’une 
des manières suivantes :
m Faites glisser une ou plusieurs couches sélectionnées d’un groupe à un autre, 
tout en maintenant la touche Option enfoncée.
m Sélectionnez une ou plusieurs couches, puis choisissez Édition > Copier (ou appuyez 
sur les touches Commande + C). Sélectionnez ensuite le groupe au sein duquel 
vous souhaitez les coller, puis choisissez Édition > Coller (ou appuyez sur les touches 
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Imbrication de groupes au sein d’autres groupes
Outre l’imbrication de couches dans des groupes, vous pouvez également imbriquer 
des groupes dans d’autres groupes. Cette organisation peut s’avérer très utile si vous 
créez une hiérarchie de couches en vue de contrôler la relation d’un groupe de couches 
vis-à-vis d’un autre ou si vous regroupez des couches auxquelles vous souhaitez appliquer 
un ensemble de comportements et de filtres.
Pour imbriquer un groupe, procédez comme pour imbriquer une couche.
Pour déplacer un groupe au sein d’un autre groupe :
1 Sélectionnez un ou plusieurs groupes.
2 Procédez de l’une des manières suivantes :
Â Faites glisser le groupe sélectionné vers un autre groupe.
Â Faites glisser le groupe sélectionné vers un nouvel emplacement sous un autre groupe.
Â Sélectionnez un ou plusieurs groupes, puis choisissez Édition > Couper (ou appuyez 
sur les touches Commande + X). Sélectionnez ensuite le groupe au sein duquel 
vous souhaitez les coller, puis choisissez Édition > Coller (ou appuyez sur les touches 
Commande + V).
Regroupement et dissociation de couches
Vous avez également la possibilité d’imbriquer des couches au sein d’un nouveau 
groupe, à l’aide de la commande Grouper. Vous pouvez ainsi regrouper des couches 
déjà affichées au sein du même groupe ou des groupes imbriqués au même niveau 
de la hiérarchie de votre projet. Il vous est impossible de regrouper des groupes 
apparaissant sur des niveaux différents.
Pour regrouper des couches sélectionnées en les imbriquant dans 
un nouveau groupe :
1 Sélectionnez l’ensemble des couches ou des groupes que vous souhaitez regrouper.
2 Choisissez Objet > Grouper (ou appuyez sur les touches Maj + Commande + G).270 Chapitre 2 Création et gestion de projets
Un nouveau groupe est créé. Il porte un numéro séquentiel en fonction du nombre 
de groupes que vous avez créés jusqu’à présent. Les couches ou les groupes que vous 
avez sélectionnés sont imbriqués à l’intérieur de ce nouveau groupe.
Il est également possible de dissocier des groupes de couches ou de groupes imbriqués. 
Le groupe d’imbrication est alors supprimé et tous les objets et les couches qui s’y 
trouvaient montent dans la hiérarchie des groupes.
Pour dissocier des couches imbriquées :
1 Sélectionnez le groupe contenant les couches ou les groupes imbriqués que 
vous souhaitez dissocier.
2 Choisissez Objet > Dissocier (ou appuyez sur les touches Option + Commande + G).
Remarque : vous ne pouvez pas dissocier des groupes qui se trouvent déjà au sommet 
de la hiérarchie de la liste de couches.
Affichage et masquage de groupes et de couches
Vous avez la possibilité de masquer les couches et les groupes apparaissant dans l’onglet 
Couches, afin de les rendre invisibles dans le Canevas, sans pour autant les supprimer 
de votre composition. Si vous avez placé un objet de taille importante dans votre projet 
et qu’il bloque l’accès à certains objets que vous souhaitez déplacer ou faire pivoter 
dans le Canevas, vous pouvez simplement masquer l’objet concerné. Vous pouvez également masquer les objets que vous n’êtes pas sûr de vouloir garder dans votre projet, 
en préservant leur emplacement pour le cas où vous souhaiteriez les réutiliser plus tard.
Si vous masquez un groupe, vous masquez également l’ensemble des couches 
et des groupes qui sont imbriqués à l’intérieur. Les couches et les groupes masqués 
ne sont pas rendus au moment de l’exportation du projet.
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Pour afficher ou masquer une ou plusieurs couches sélectionnées, procédez de 
l’une des manières suivantes :
m Cochez la case située à gauche d’un objet ou d’un groupe dans l’onglet Couches 
ou la Timeline.
m Choisissez Objet > Activer (ou appuyez sur les touches Contrôle + T) pour activer 
ou désactiver l’affichage des couches.
m Cliquez sur une couche ou sur un groupe tout en maintenant la touche Contrôle 
enfoncée, puis choisissez Activer dans le menu contextuel.
Remarque : si vous masquez une ou plusieurs couches d’un groupe, la case d’activation 
de ce groupe affiche un tiret plutôt qu’une coche, pour indiquer que toutes ses couches 
ne sont pas visibles.
Vous pouvez placer en « solo » une couche ou un groupe afin de masquer toutes 
les autres couches du projet. Cette technique peut servir à isoler un objet individuel 
dans le Canevas, afin de l’animer ou de le manipuler sans interférer avec d’autres objets 
de votre composition.
Pour mettre une couche en solo :
1 Sélectionnez les couches ou les groupes à mettre en solo.
2 Choisissez Objet > Solo (ou appuyez sur les touches Contrôle + S).
Remarque : vous pouvez également cliquer sur un objet avec la touche Contrôle 
enfoncée dans l’onglet Couches, puis sélectionner Solo dans le menu contextuel.
Case d’activation
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Toutes les autres couches ou tous les autres groupes sont désactivés. Seul l’objet mis en 
solo est visible dans le Canevas. Lorsque l’élément sélectionné est en solo, une coche 
apparaît en regard de la commande dans le menu Solo.
Définition de la taille d’un groupe
Par défaut, la taille d’un groupe est déterminée par les couches qu’il contient. Comme les 
objets animés ont souvent tendance à gagner en taille, la hauteur et la largeur actives 
d’un groupe (sa résolution) peuvent devenir très conséquentes. Vous pouvez donc limiter 
la taille d’un groupe à une largeur et une hauteur déterminées dans l’onglet Couches de 
l’Inspecteur.
Le projet affiché dans l’image suivante contient un système de particules. Bien que 
les particules animées ne soient plus visibles une fois qu’elles sont sorties du Canevas, 
il est à noter qu’elles rendent le groupe qui les contient très volumineux.
Vous avez la possibilité de rogner la taille d’un groupe contenant des objets dont 
la taille augmente à l’aide de la case à cocher Résolution fixe, située sous l’onglet 
Groupe de l’Inspecteur.
Taille par défaut d’une couche contenant des particules
Cadre de sélection des 
particules
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Si votre projet contient des objets animés qui se déplacent ou grossissent au-delà 
des bords du Canevas et que vous n’avez pas coché la case Résolution fixe, le temps 
de traitement nécessaire à votre ordinateur risque de s’allonger.
Remarque : l’onglet Groupe de l’Inspecteur (qui contient le paramètre Résolution fixe) 
n’est accessible que si un groupe est sélectionné dans le projet.
Lorsque le paramètre Résolution fixe est activé, les objets situés au sein du groupe, 
mais en dehors du Canevas, sont rognés à la taille du groupe, telle qu’elle est définie 
dans ce paramètre.
En cas d’activation, le paramètre Résolution fixe rogne le groupe à la taille spécifiée 
dans les paramètres Largeur fixe et Hauteur fixe. En d’autres termes, si le point 
d’ancrage du groupe est décalé, il est possible que le rognage ne soit pas appliqué 
autour des bords du Canevas et que des objets soient coupés.
Pour fixer la résolution d’un groupe :
1 Sous l’onglet Couches (ou dans la liste de couches de la Timeline), sélectionnez 
le groupe.
Groupe sélectionné avec un point d’ancrage décalé avant 
l’activation du paramètre Résolution fixe
Groupe sélectionné avec le paramètre Résolution fixe activé et défini 
sur la taille du projet. Notez que les objets texte sont coupés.
Point d’ancrage
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2 Dans l’Inspecteur, cliquez sur l’onglet Groupe.
3 Cochez la case Résolution fixe.
Par défaut, la résolution du groupe est définie sur la taille du projet.
4 Pour définir une résolution différente de celle du projet, ajustez les curseurs Largeur 
fixe et Hauteur fixe.
Remarque : si une couche est sélectionnée au sein d’un groupe à résolution fixe, 
son cadre de sélection apparaît à sa taille d’origine, sans tenir compte de la résolution 
du groupe qui la contient.
Verrouillage de groupes et de couches
Dès lors que vous avez terminé vos réglages sur une couche ou un groupe particulier, 
vous pouvez verrouiller cet élément pour éviter toute modification accidentelle. Il est 
impossible de déplacer des couches verrouillées, ni de modifier ou d’animer leurs paramètres. L’animation et les comportements appliqués à une couche avant son verrouillage 
sont toujours actifs. Le verrouillage d’un groupe entraîne également le verrouillage 
de toutes les couches et des groupes imbriqués à l’intérieur.
Pour verrouiller des couches ou des groupes, procédez de l’une des 
manières suivantes :
m Cliquez sur l’icône de verrouillage de la couche dans l’onglet Couches.
Case Résolution fixe cochée 
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m Sélectionnez un ou plusieurs groupes ou couches, puis choisissez Objet > Verrouiller 
(ou appuyez sur les touches Contrôle + L).
Le cadre de sélection délimitant la couche verrouillée dans le Canevas devient rouge 
pour indiquer que cet élément est verrouillé.
Réduction et développement des hiérarchies de groupes
Dans l’onglet Couches, les groupes et les couches sont affichés sous la forme d’une hié-
rarchie qui signale quelles couches sont imbriquées dans tel ou tel groupe. Les couches et les groupes imbriqués apparaissent en dessous du groupe dans lequel ils sont 
imbriqués et ils décalés vers la droite. 
Pour simplifier la gestion de la liste de couches, vous pouvez réduire toutes les couches 
imbriquées dans un groupe particulier via le triangle d’affichage de ce groupe. Les groupes 
réduits sont affichés dans la liste sous la forme d’une simple ligne. Ils peuvent être déplacés 
ou imbriqués comme n’importe quelle autre couche. Cependant, chaque groupe possède 
une vignette qui affiche un aperçu de l’ensemble de sa composition, ce qui permet de 
savoir aisément quels éléments sont imbriqués à l’intérieur.
Pour développer ou réduire un seul groupe, procédez de l’une des 
manières suivantes :
m Cliquez sur le triangle d’affichage situé à gauche du nom et de l’icône du groupe.
m Appuyez sur la touche Flèche vers le haut ou vers le bas pour monter ou descendre 
dans la liste de couches, puis sur la Flèche vers la droite pour développer un groupe 
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Attribution de nouveaux noms aux groupes
Vous pouvez renommer les groupes et les couches qui apparaissent dans l’onglet 
Couches, afin d’organiser au mieux vos médias et d’identifier plus facilement le but 
de chaque groupe ou objet. Lorsque vous renommez une couche, le nom original 
de son fichier de média source demeure inchangé. De plus, la modification du nom 
d’une couche dans l’onglet Couches ne modifie pas le nom de l’objet correspondant 
dans l’onglet Média. Vous ne pouvez pas modifier le nom d’un objet dans l’onglet Média. 
Pour renommer un groupe ou une couche :
1 Double-cliquez sur le nom du groupe ou de la couche à renommer.
2 Lorsque le nom est mis en surbrillance, tapez un nouveau nom.
3 Une fois terminé, appuyez sur la touche Retour pour valider le nouveau nom. 
Vous pouvez également valider le nouveau nom en cliquant sur une autre couche 
ou un autre groupe.
Remarque : une fois que le nom d’une couche a été modifié dans Motion, il n’existe 
pas de méthode automatique permettant de rétablir son ancien nom, à l’exception 
de la commande Annuler.
Recherche de groupes et de couches
Il est parfois difficile de retrouver un groupe ou une couche dans un très grand projet. 
Utilisez alors le champ Rechercher situé au-dessus des onglets Couches, Média et Audio. 
Son fonctionnement est similaire au champ de recherche du Navigateur. Il vous permet 
de rechercher toutes les couches ou tous les groupes dont le nom contient le terme 
que vous recherchez.
Pour rechercher un groupe ou une couche en fonction de son nom dans 
l’onglet Couches :
m Tapez un terme à rechercher dans le champ Rechercher. 
Dès que vous vous mettez à saisir les premières lettres, tous les groupes et les couches 
dont les noms ne contiennent pas le terme recherché sont masqués, laissant apparaître 
une liste contenant uniquement les couches et les groupes dont les noms correspondent 
à votre recherche.
Pour effacer les résultats de recherche :
m Cliquez sur le bouton Effacer, située à l’extrême droite du champ Rechercher, afin 
de restaurer le contenu intégral des onglets Couches, Média ou Audio.
Remarque : les groupes et les couches masqués suite à une opération de recherche ne 
sont pas désactivés dans le Canevas et ils ne sont exclus du rendu durant l’exportation.
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Outre la recherche de couches en fonction du nom, il est possible d’utiliser la commande 
Afficher le média source pour retrouver les données source de n’importe quel objet 
dans l’onglet Média.
Pour afficher le média source d’un objet sous l’onglet Média, procédez de l’une 
des manières suivantes :
m Tout en maintenant la touche Contrôle enfoncée, cliquez sur un objet dans le Canevas 
ou sur une couche dans l’onglet Couches ou la Timeline, puis choisissez Afficher le média 
source dans le menu contextuel.
m Sélectionnez un objet dans le Canevas ou une couche dans l’onglet Couches ou la Timeline, puis choisissez Objet > Afficher le média source (o appuyez sur les touches Maj + F).
L’onglet Média et l’Inspecteur s’ouvrent tous les deux. L’objet « de référence » 
est sélectionné et ses paramètres d’onglet Média sont affichés dans l’Inspecteur.
Tri des objets dans l’onglet Média
L’onglet Média contient 13 colonnes qui fournissent des informations sur chaque objet 
de votre projet.
Colonne Description
Preview Affiche l’objet média sous forme de vignette.
Nom Indique le nom de fichier du média source stocké sur disque, auquel l’objet est lié. 
Si vous modifiez le nom des objets liés correspondants dans l’onglet Couches, 
ce nom ne change pas.
Type Indique le type du fichier, que ce soit une image fixe, une séquence QuickTime, 
une séquence d’images ou un fichier audio.
En service Indique si ce média est utilisé ou non dans le projet.
Durée Affiche la durée totale de l’objet, en images ou en timecode, selon ce qui est affiché 
dans la Timeline.
Taille d’image Affiche les dimensions de l’image de l’objet, en pixels.
Compresseur Si l’objet est une séquence QuickTime, affiche le codec utilisé. En revanche, 
s’il s’agit d’une image fixe, affiche la méthode de compression appliquée 
en fonction du type de fichier.
Profondeur Spécifie la profondeur de couleur de l’image.
Fréquence d’images Affiche la fréquence d’images de l’objet, en images par seconde.
Débit Indique le débit des données auquel une séquence QuickTime est compressée.
Échantillonnage Pour les fichiers audio et les séquences QuickTime, affiche la fréquence d’échantillonnage audio.
Format audio Pour les fichiers audio et les séquences QuickTime, affiche la profondeur de bits 
audio.
Taille du fichier Affiche la taille du fichier de média source sur disque.
Fichier créé le Affiche la date de création du fichier de média source sur disque.
Fichier modifié le Affiche la date de modification du fichier de média source sur disque. Ce paramètre 
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Vous pouvez personnaliser l’onglet Média afin d’afficher, de masquer ou de réarranger 
l’une ou l’autre de ces colonnes en fonction de vos besoins. Vous pouvez également 
redimensionner les vignettes affichées pour chaque objet.
Pour afficher ou masquer une colonne :
m Cliquez sur le signe supérieur (>) situé à droite des en-têtes de colonnes, puis activez 
ou désactivez dans le menu local les colonnes que vous souhaitez afficher ou masquer.
Pour déplacer une colonne vers la droite ou vers la gauche :
m Faites glisser l’en-tête de la colonne vers la droite ou la gauche pour la déplacer.
Pour augmenter ou réduire la taille de la vignette de chaque objet, 
effectuez l’une des opérations suivantes :
m Utilisez le curseur d’échelle qui se trouve en bas de l’onglet Média.
m Faites glisser le séparateur entre les lignes d’objets.
Personnalisation et création de nouveaux modèles
Motion vous est fourni avec une collection de modèles prêts à être personnalisés. 
Il vous permet en outre de créer aisément vos propres modèles.
Personnalisation de projets créés à partir de modèles
Lorsque vous créez pour la première fois un nouveau fichier de projet à partir d’un 
modèle, il s’agit d’une copie du modèle original. Les projets créés à partir de modèles 
ne présentent aucune particularité spéciale et peuvent être édités et modifiés comme 
n’importe quel autre projet. Il existe quelques méthodes spécifiques qui vous seront 
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Rappelez-vous que la plupart des modèles, plus particulièrement ceux que vous créez 
vous-même, sont destinés à simplifier le processus de création de titres et d’éléments 
graphiques pour les projets répétitifs. Il s’agit par exemple de titres et de tiers inférieurs 
destinés aux programmes d’information et aux interviews, d’éléments graphiques pour 
les magazines et tout autre programme qui requiert des titres d’aspect homogène qu’il 
faut mettre à jour d’une émission à l’autre. Les modèles bien conçus vous permettent 
de remplacer tout simplement les objets graphiques importants et d’éditer le texte afin 
de les mettre à jour pour la prochaine émission.
Les modifications apportées aux projets créés à partir de modèles n’ont aucun effet 
sur les modèles d’origine.
Échange d’objets
La manière la plus simple de personnaliser un projet créé à partir d’un modèle consiste 
à remplacer par vos propres objets les objets utilisés dans le modèle, à partir du Navigateur ou de la Bibliothèque. Lorsque vous remplacez un objet, le nouvel objet apparaît 
dans votre projet avec les mêmes valeurs de paramètre que celles utilisées par l’objet 
précédent. De plus, les filtres, masques, comportements ou paramètres animés avec des 
images clés appliqués à l’objet original demeurent appliqués à l’objet de substitution.
Même s’il existe plusieurs groupes appelés « Zone de dépôt » dans divers modèles, 
ce sont les objets situés à l’intérieur de ces groupes qui doivent être remplacés, et 
non les couches proprement dites.
Remarque : pour identifier rapidement tous les objets à remplacer dans un modèle, 
saisissez « Zone de dépôt » dans le champ Rechercher de l’onglet Couches, puis appuyez 
sur Retour. Tous les objets « Zone de dépôt » apparaissent alors dans l’onglet Couches.
Pour en savoir plus sur le remplacement d’objets, lisez la rubrique « Échange de médias 
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Zones de dépôt
Les zones de dépôt vous permettent de remplacer rapidement une séquence d’un projet, 
en déposant directement des plans dans le Canevas. Une zone de dépôt est représentée 
par un rectangle comportant une flèche vers le bas au centre. Le nom de la couche de 
la zone de dépôt apparaît également au centre de cette zone. Tout objet de média glissé 
et déposé dans la région définie par l’objet Zone de dépôt remplace automatiquement 
la représentation graphique de ladite zone. Lorsque vous faites glisser un média au-dessus 
de la zone de dépôt, une surbrillance apparaît autour de cette zone.
Remarque : si plusieurs zones de dépôt se chevauchent dans le Canevas, la zone située 
sur le dessus est prioritaire dès lors qu’un élément est glissé sur la zone.
Pour en savoir plus sur les zones de dépôt, voir « Utilisation des zones de dépôt » 
à la page 282.
Personnalisation des objets texte
L’outil Texte permet de mettre aisément à jour les objets texte. La modification d’un 
objet texte n’a aucun effet sur le format, le style ou la présentation du texte. De plus, 
les modifications simples effectuées sur des objets texte n’ont pas d’effet sur les filtres, 
les masques, les comportements ou les paramètres animés par images clés appliqués 
à cet objet.
Pour en savoir plus sur la modification des objets texte, lisez la rubrique « Utilisation du 
texte » à la page 619.
Zone de dépôt vierge Séquence Quicktime glissée au-dessus d’une zone 
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Modification des comportements et des images clés
Les objets présents dans les projets créés à partir de modèles sont animés à l’aide 
d’une combinaison de comportements et de paramètres animés avec des images clés. 
Ces éléments peuvent être modifiés à tout moment pour personnaliser le mouvement 
des objets. Pour en savoir plus sur la modification des comportements, lisez la rubrique 
« Modification des comportements » à la page 423. Pour en savoir plus sur la modification des images clés, lisez la rubrique « Modification d’images clés » à la page 586.
Création de nouveaux modèles
Outre l’utilisation et la personnalisation des modèles fournis avec Motion, vous pouvez 
également créer vos modèles en partant de zéro. Les fichiers de modèle contiennent 
tous les éléments que l’on trouve dans un projet ordinaire, notamment des objets de 
médias, des objets texte, des formes, des générateurs, des comportements et des filtres, 
dans toutes les combinaisons possibles.
Vous pouvez créer vos modèles personnalisés à utiliser dans les plans fréquemment 
utilisés que vous devez créer régulièrement. Si vous créez des titres destinés à un 
programme d’informations, vous pouvez créer des modèles pour le titre d’ouverture, 
les images interstitielles, les intercalaires et autres plans répétitifs qu’il est nécessaire 
de créer régulièrement. Après avoir enregistré vos modèles, il suffit de charger le 
modèle nécessaire, plutôt que de devoir chaque fois créer un titre en partant de zéro, 
puis de le personnaliser à l’aide des dates, du texte et des nouveaux films et images 
afin de l’adapter aux besoins du nouveau programme.
Utilisation d’objets, de comportements et d’images clés à partir 
de modèles
Il peut parfois s’avérer nécessaire d’utiliser dans votre projet un paramètre animé avec 
des images clés ou un comportement tiré d’un modèle. Vous pouvez toujours créer 
un projet à partir d’un modèle, sélectionner les images clés ou les comportements 
à utiliser, les copier, puis les coller dans votre projet.
Tous les objets graphiques utilisés par les modèles apparaissent également dans la 
catégorie Contenu de la Bibliothèque, au sein de la sous-catégorie Média de modèle. 
Vous pouvez retrouver dans la Bibliothèque les éléments graphiques particuliers que 
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Les modèles ne sont rien d’autre que des fichiers Motion enregistrés d’une manière 
spéciale. Pour créer un modèle, il suffit de créer la maquette dont vous avez besoin, 
comme pour n’importe quel autre projet Motion. Avant d’utiliser la maquette comme 
modèle, gardez à l’esprit les informations suivantes :
Attribution de noms aux objets dans la liste de couches
Les noms que vous attribuez aux groupes et aux couches de votre modèle doivent indiquer 
la fonction de chaque objet. Vous pouvez par exemple nommer les objets d’un modèle de 
titre de la manière suivante : « Titre principal », « Rôle principal », « Second rôle », etc. Si vous 
utilisez des éléments visuels dans la composition du modèle, décrivez leur fonction, comme 
par exemple : « Texture d’arrière-plan », « Séparateur », « Titre principal d’arrière-plan », etc. 
Cela permettra à toute personne désireuse de personnaliser votre modèle d’en identifier 
facilement les différents éléments ainsi que leur fonction.
Utilisation des zones de dépôt
Les zones de dépôt offrent aux utilisateurs une méthode intuitive pour remplacer 
des séquences dans un modèle. Il existe deux façons de créer des zones de dépôt. 
La première consiste à créer une zone de dépôt de toutes pièces, la deuxième 
à convertir un objet existant en zone de dépôt.
Pour créer une nouvelle zone de dépôt, procédez de l’une des manières suivantes :
m Choisissez Objet > Nouvelle zone de dépôt (ou appuyez sur les touches Commande + 
Maj + D).
m Sélectionnez un objet existant dans le Canevas, puis cochez la case Zone de dépôt 
dans l’onglet Image de l’Inspecteur.
Cet onglet contient des commandes permettant d’ajuster la zone de dépôt :
Zone de dépôt : case à cocher permettant d’indiquer si l’objet est oui ou non une 
zone de dépôt.
Ajuster : menu local vous permettant de choisir entre trois méthodes de placement 
de l’objet dans la zone de dépôt. Les valeurs possibles sont Ajuster, Au centre ou Étirer. 
La valeur Ajuster modifie automatiquement le paramètre Échelle du nouveau média, 
afin qu’il s’ajuste proportionnellement aux dimensions de la zone de dépôt. La valeur 
Au centre ne modifie en rien l’objet, mais le place simplement au centre de la zone de 
dépôt. Si le média inséré est d’une résolution différente de celle du projet, cette nouvelle 
résolution est utilisée sans apporter aucune modification au paramètre Échelle. Si la valeur 
Étirer est sélectionnée, l’objet déposé est étiré afin de s’adapter aux dimensions de 
la zone de dépôt.
Effacer : bouton permettant d’effacer l’image déposée dans la zone et de la remplacer 
par la représentation graphique par défaut de la zone.Chapitre 2 Création et gestion de projets 283
Création de plusieurs projets pour chaque niveau de résolution requis
Si vous créez régulièrement des projets pour divers formats, vous gagnerez du temps 
en créant à l’avance une version de votre projet pour chaque niveau de résolution 
requis. Au moment d’enregistrer le projet comme modèle, vous pouvez en spécifier 
le format afin de le repérer immédiatement plus tard.
Consolidation des médias
À moins d’avoir sélectionné un autre emplacement lors de l’installation de Motion, 
les modèles intégrés sont enregistrés dans le dossier /Bibliothèque/Application Support/
Final Cut Studio/Motion/Templates. Vos modèles personnalisés sont enregistrés dans 
le dossier /Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/
Final Cut Studio/Motion/Templates, mais les médias utilisé dans ces modèles restent 
à leur emplacement d’origine sur le disque. Si vous déplacez, renommez ou supprimez 
tout fichier de médias utilisé par un modèle, l’objet concerné devient offline dans tous 
les projets créés à partir de ce modèle.
Pour éviter cela, il est recommandé de déplacer dans un dossier central du disque 
tous les fichiers de médias que vous comptez utiliser, avant de les importer dans 
le fichier de projet que vous enregistrerez comme modèle. Cela vous aidera à ne pas 
perdre ces fichiers de médias. Vous pouvez également utiliser la commande Fichier > 
Enregistrer sous et l’option Recueil données. Pour en savoir plus, voir « Recueil des 
données » à la page 212.
∏ Conseil : si vous envisagez de partager vos modèles personnalisés avec d’autres utilisateurs, il est recommandé de copier leur dossier à cet emplacement /Utilisateurs/nom 
d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/Motion/Templates des 
ordinateurs concernés.
Remarque : dans la section Générales des préférences Motion (appuyez sur les touches 
Commande + virgule), vous pouvez indiquer à Motion le dossier de votre système 
ou du réseau dans lequel se trouvent le contenu et les modèles. Cela permet également 
à plusieurs utilisateurs d’un réseau de partager un dossier unique centralisé.284 Chapitre 2 Création et gestion de projets
Pour enregistrer un projet comme modèle :
1 Choisissez Fichier > Enregistrer comme modèle.
La zone de dialogue Enregistrer apparaît.
Remarque : il est recommandé de créer un nouveau thème personnalisé pour 
enregistrer vos propres modèles.
2 Si vous souhaitez créer un nouveau thème pour y ajouter votre modèle, cliquez sur 
Nouveau thème, attribuez un nom au thème dans la zone de dialogue qui apparaît, 
puis cliquez sur Créer.
3 Dans la zone de dialogue Enregistrer, attribuez un nom au modèle.
4 Dans le menu local Thème, choisissez un thème dans lequel stocker votre modèle.
5 Choisissez le format de votre modèle via le menu local Format.
6 Si vous voulez doter votre modèle d’un aperçu lorsqu’il est affiché dans le Navigateur 
de modèles, choisissez Créer un Preview QuickTime.
7 Cliquez sur Enregistrer.
Votre nouveau modèle est enregistré dans le thème que vous avez sélectionné. 
Les modèles personnalisés sont enregistrés dans le dossier /Utilisateurs/nom d’utilisateur/
Bibliothèque/Application Support/Final Cut Studio/Motion/Templates, dans un dossier 
portant le nom du thème que vous avez sélectionné.
Organisation des modèles dans le Navigateur de modèles
Vous pouvez utiliser le Navigateur de modèles pour sélectionner et organiser 
vos modèles, si nécessaire. Tous les modèles sont classés par catégories. Vous pouvez 
ajouter des catégories, les supprimer ou les renommer directement dans le Navigateur 
de modèles.
Pour ajouter une catégorie dans le Navigateur de modèles :
1 Choisissez Fichier > Ouvrir un modèle.
Le Navigateur de modèles apparaît.
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3 Attribuez un nom au thème dans la zone de dialogue située au-dessus du Navigateur 
de modèles.
4 Cliquez sur Créer.
La nouvelle catégorie apparaît dans la colonne Thème sur la gauche.
Pour supprimer une catégorie dans le Navigateur de modèles :
1 Choisissez Fichier > Ouvrir un modèle.
Le Navigateur de modèles apparaît.
2 Sélectionnez une catégorie dans la colonne Thème.
3 Appuyez sur la touche Suppr.
Une zone de dialogue d’avertissement vous invite à confirmer la suppression.
4 Cliquez sur le bouton Supprimer.
Le répertoire du disque correspondant à cette catégorie est placé dans la Corbeille, 
mais il n’est pas supprimé. Tout fichier de modèle présent dans le répertoire de cette 
catégorie est également placé dans la Corbeille.
Pour supprimer des modèles à partir du Navigateur de modèles :
1 Choisissez Fichier > Ouvrir un modèle.
Le Navigateur de modèles apparaît.
2 Sélectionnez un modèle.
3 Appuyez sur la touche Suppr.
Une zone de dialogue d’avertissement vous invite à confirmer la suppression.
4 Cliquez sur le bouton Supprimer.3
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Pour l’essentiel, le compositing 2D se résume à organiser 
les éléments visuels de votre composition en contrôlant 
le déplacement, le pivotement, la mise à l’échelle et le réglage 
de la transparence de chaque objet de votre projet.
Le compositing est le processus consistant à associer au moins deux images en vue 
de d’obtenir un résultat final intégré. Cela peut être tout simplement l’ajout de texte sur 
une image ou par exemple, et c’est là que les choses se compliquent, l’association d’images représentant des acteurs en chair et en os à celles d’aliens en furie avec des rayons 
laser sortant des yeux. Les spécialistes de l’animation peuvent être amenés à déplacer à 
l’écran plusieurs objets simultanément et doivent donc faire preuve d’un grand sens de 
création visuelle. Ils ont recours à des techniques diverses : modifier l’ordre des groupes 
et des objets, transformer les propriétés physiques d’un objet (telles que son échelle), 
modifier les réglages du mode de fusion et l’opacité des objets, appliquer des filtres à des 
objets et créer du texte et des formes. Les projets d’animation graphique associent souvent des techniques de présentation et de conception à des techniques utilisées à l’origine pour la création d’effets spéciaux : incrustation, masques, étalonnage et création de 
systèmes de particules.
Une fois les objets nécessaires à votre projet importés, la première étape consiste 
à disposer les objets à l’intérieur du Canevas afin d’obtenir un premier jet de votre 
œuvre. Avant même d’ajouter la moindre animation, vous devez notamment définir 
les dimensions de chaque objet et leur emplacement au cas où vous envisageriez 
de faire tourner des objets sur eux-mêmes. Vous pouvez bien évidemment effectuer 
des manipulations plus complexes afin de créer d’autres effets. Il vous est tout à fait 
possible, par exemple, de rogner les parties non désirées d’un objet.288 Chapitre 3 Compositing standard
Vous pouvez utiliser différents outils de transformation afin de mener à bien des tâches 
de compositing élémentaires : sélection, déplacement, pivotement, mise à l’échelle, 
déformation simple ou par les angles, rognage, modification du point d’ancrage d’un 
objet et manipulation des ombres portées. Ces outils de transformation sont disponibles 
dans la section Présentation de la barre d’outils. Lorsque vous passez d’un outil de transformation à l’autre, des commandes à l’écran différentes sont affichées dans le Canevas. 
Il vous suffit de faire glisser ces commandes pour réaliser l’opération de transformation 
sélectionnée.
D’autres commandes de la palette vous permettent de modifier l’opacité, le mode 
de fusion et les réglages d’ombre portée de chaque objet sélectionné.
Tout comme les commandes à l’écran, les commandes de la palette correspondent 
à des paramètres affichés dans l’onglet Propriétés de l’Inspecteur. Chaque paramètre 
correspond à une commande du Canevas différente et chaque réglage apporté dans 
le Canevas se reflète simultanément dans l’Inspecteur. Par exemple, si vous utilisez 
l’outil Sélectionner/Transformer et que vous modifiez l’échelle d’un objet en faisant 
glisser l’une de ses poignées d’angle dans le Canevas, son paramètre Échelle est 
immédiatement mis à jour dans l’onglet Propriétés de l’Inspecteur.
Faites glisser l’une des poignées d’angle d’un objet pour 
le redimensionner en mode de transformation.Chapitre 3 Compositing standard 289
Lorsque vous commencez à créer la présentation d’une composition, il est recommandé 
de créer avant toute chose une présentation statique de votre projet, autrement dit 
la représentation de ce dernier à un moment précis, au début ou à la fin du projet. 
Vous ne pouvez pas seulement manipuler la géométrie des objets de votre projet, 
vous pouvez également jouer sur leur opacité. Cela vous donne davantage de manœuvre 
au moment de définir la fusion d’éléments de votre présentation qui se superposent. 
Quant aux modes de fusion, ils vous permettent de mieux définir l’apparence des objets 
superposés, en accentuant ou stylisant les couleurs des objets supérieurs à partir 
des objets inférieurs.
Une fois la présentation initiale créée, vous pouvez animer tout objet ajouté pour 
donner une impression de mouvement à votre projet. Pour en savoir plus sur l’animation 
et les propriétés des objets, voir « Animations dans Motion » à la page 548.
Ordre des groupes et des couches
Comme le chapitre 2, « Création et gestion de projets », le mentionne au sujet des 
projets 2D, l’ordre dans lequel les couches et les groupes apparaissent dans l’onglet 
Couches et la Timeline détermine l’ordre dans lequel elles sont affichées les unes par 
rapport aux autres dans le Canevas (l’ordre des couches). Avant d’effectuer le moindre 
outil décrit dans ce chapitre, vous devez tout d’abord organiser les couches et les groupes 
de votre projet dans l’ordre approprié. 
Commandes Disposition du menu Objet
Vous pouvez bien sûr modifier la disposition des objets dans l’onglet Couches. Toutefois, 
vous avez également la possibilité de faire passer un objet au-dessus ou en dessous 
d’un autre à l’aide des commandes du menu Objet. Cette méthode peut notamment 
s’avérer très utile lorsque vous avez besoin de déplacer rapidement un objet au premier 
plan dans le Canevas. Plutôt que de passer par l’onglet Couches, utilisez tout simplement 
l’une des commandes du menu Objet.
Les commandes Disposition s’appliquent aussi bien aux objets et aux groupes, qu’aux 
groupes imbriqués au sein d’un autre groupe. Toutefois, la réorganisation d’un groupe 
réorganise aussi tous les objets imbriqués à l’intérieur. 
Remarque : vous ne pouvez pas utiliser les commandes Réorganiser pour déplacer 
des objets en dehors du groupe au sein duquel ils sont imbriqués.
Le menu Objet comporte quatre commandes de réorganisation :290 Chapitre 3 Compositing standard
Faire passer au premier plan : place l’objet sélectionné au premier plan par rapport 
à tous les autres objets du même groupe, en le faisant passer tout en haut du groupe 
d’objets imbriqués dans l’onglet Couches et dans le Canevas.
Faire passer à l’arrière-plan : place l’objet sélectionné à l’arrière-plan par rapport à 
tous les autres objets du même groupe, en le faisant passer tout en bas du groupe 
d’objets imbriqués dans l’onglet Couches et dans le Canevas.
Avancer d’un plan : avance l’objet sélectionné d’un niveau dans la hiérarchie 
des objets imbriqués au sein du même groupe dans l’onglet Couches et le Canevas, 
le rapprochant ainsi du premier plan dans le Canevas.
Reculer d’un plan : recule l’objet sélectionné d’un niveau dans la hiérarchie des objets 
imbriqués au sein du même groupe dans l’onglet Couches et le Canevas, le rapprochant 
ainsi de l’arrière-plan dans le Canevas.
Avant Après 
Avant Après Chapitre 3 Compositing standard 291
Réorganisation de sélections non adjacentes
Si vous utilisez une commande de réorganisation sur une sélection de couches 
non adjacentes, elles sont décalées ensemble vers le haut ou le bas de la hiérarchie 
et l’espace qui les séparait est réduit.
Transformation d’objets et de couches dans le Canevas
Le terme transformation couvre toute opération effectuée sur un objet, notamment son 
déplacement, son redimensionnement ou son pivotement. Vous pouvez transformer 
des objets soit directement à l’aide des commandes à l’écran (les poignées de transformation), soit en modifiant leurs paramètres dans l’onglet Propriétés de l’Inspecteur. 
En général, les commandes du Canevas permettent de voir directement les modifications 
apportées alors que les paramètres de l’onglet Propriétés s’utilisent plutôt lorsque 
vous apportez des modifications nécessitant une très grande précision. Pour certaines 
opérations, il est même possible d’utiliser les touches du clavier.
Sélection d’objets pour les transformer
Avant de pouvoir procéder à des transformations, vous devez sélectionner les objets 
et les groupes que vous souhaitez transformer dans le Canevas, l’onglet Couches ou 
la Timeline. Si vous sélectionnez un groupe ou un objet à l’un de ces trois emplacements, 
il est également sélectionné dans les deux autres.
Si vous sélectionnez un objet dans le Canevas, il est entouré par un cadre de sélection 
doté de poignées de transformation correspondant au mode de transformation actuellement sélectionné. Ces poignées permettent de transformer chaque objet sélectionné.
Pour sélectionner un seul objet dans le Canevas :
m Cliquez sur l’objet à sélectionner dans le Canevas.
Commande Avancer d’un plan
appliquée
Sélection de couches non 
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Pour sélectionner plusieurs objets dans le Canevas ou pour ajouter des objets 
à une sélection, effectuez l’une des opérations suivantes :
m Tracez une zone de sélection à l’aide de la souris tout autour des objets à sélectionner.
m Cliquez sur les objets à sélectionner tout en appuyant sur la touche Maj du clavier.
m Pour ajouter des objets à une sélection, faites glisser un cadre de sélection autour des 
objets à ajouter à l’aide de la souris tout en appuyant sur la touche Maj ou Commande.
Pour désélectionner l’un des multiples objets sélectionnés dans le Canevas, 
effectuez l’une des opérations suivantes :
m Maj tout en cliquant sur l’objet à désélectionner. 
Tous les autres objets sélectionnés ne sont pas désélectionnés.
m Tracez un cadre de sélection autour des objets à désélectionner à l’aide de la souris 
tout en appuyant sur la touche Maj ou Commande.
Pour sélectionner tous les objets du Canevas, procédez de l’une des manières 
suivantes :
m Choisissez Tout sélectionner dans le menu Édition.
m Appuyez simultanément sur les touches Commande + A.
Pour désélectionner tous les objets du Canevas, procédez de l’une des manières 
suivantes :
m Choisissez Tout désélectionner dans le menu Édition.
m Appuyez simultanément sur les touches Maj + Commande + A.
Il peut arriver parfois qu’un objet se retrouve caché par un autre objet. La meilleure 
façon de sélectionner un objet caché consiste à le sélectionner dans l’onglet Couches 
ou dans la Timeline. Lorsque vous procédez ainsi, le cadre de sélection de l’objet 
et les commandes de transformation du Canevas permettent de sélectionner l’objet, 
même si celui-ci est entièrement caché.
Remarque : lorsqu’un objet inactif est sélectionné, vous voyez uniquement la zone 
de sélection de cet objet.
Pour en savoir plus sur la sélection d’objets et de groupes dans l’onglet Couches, 
voir « Sélection de couches et de groupes dans l’onglet Couches » à la page 266.Chapitre 3 Compositing standard 293
Règles de transformation des objets et groupes sélectionnés
La méthode de transformation des objets sélectionnés dépend du nombre d’objets 
sélectionnés.
Transformation d’un seul objet
Si un seul objet est sélectionné, les modifications apportées ne s’appliquent qu’à 
cet objet. Tous les autres objets non sélectionnés ne sont pas modifiés. Par exemple, 
si vous sélectionnez un seul objet, des poignées de transformation apparaissent autour 
de celui-ci.
Transformation de plusieurs objets
Si vous sélectionnez plusieurs objets dans le Canevas, les modifications apportées 
à un seul objet s’appliquent immédiatement à tous les autres objets. Chaque transformation ayant lieu autour du point d’ancrage de chaque objet, l’effet est le même que 
si vous appliquiez la même transformation à la poignée de chaque objet, l’une après 
l’autre.
Avant la mise à l’échelle Après la mise à l’échelle
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Transformation d’un groupe
Si vous sélectionnez un groupe entier, tous les objets et les groupes imbriqués à l’inté-
rieur de ce groupe sont traités comme s’il s’agissait d’un seul objet. Un seul ensemble 
de poignées de transformation apparaît donc sur le cadre de sélection regroupant 
tous les objets de ce groupe. De même, toutes les transformations appliquées aux 
objets sont exécutées à partir d’un seul point d’ancrage appartenant au groupe.
Utilisation des outils de transformation 2D
Les outils de transformation permettent de disposer et de manipuler des objets dans 
l’espace du Canevas. Comme leur nom l’indique, ils vous offrent la possibilité de transformer des objets et des groupes de votre projet en contrôlant leur déplacement, mise 
à l’échelle, rotation, déformation, déformation par les angles et rognage. Chacune de ces 
opérations peut être réalisée de deux manières : en utilisant des poignées graphiques 
dans le Canevas ou en utilisant les paramètres de chaque objet, situés dans l’Inspecteur. 
Cette section s’attache à décrire l’utilisation des commandes graphiques disponibles dans 
le Canevas. Ces commandes à l’écran représentent la méthode la plus intuitive et la plus 
pratique pour organiser des objets dans votre projet. Pour en savoir plus sur la correspondance entre chaque transformation, ses paramètres et les valeurs numériques correspondantes, voir « Commandes de géométrie d’un objet dans l’Inspecteur » à la page 311.
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Passage d’un outil de transformation à l’autre
Avant de transformer un objet, prenez soin de sélectionner le pointeur correspondant 
à l’outil de transformation souhaité. Ces outils peuvent être sélectionnés dans la barre 
d’outils. 
Les six principaux outils de transformation 2D sont les suivants :
Sélectionner/Transformer : met à l’échelle et fait pivoter les objets sélectionnés.
Ajuster le point d’ancrage : décale le point d’ancrage utilisé pour toutes les transformations d’objet.
Ajuster la déformation : incline les objets horizontalement ou verticalement.
Ajuster l’ombre portée : manipule les ombres portées des objets directement dans 
le Canevas.
Ajuster les quatre angles : étire un objet pour créer différentes formes de polygone.
Ajuster le rognage : supprime certains pixels de l’objet à partir de l’un de ses quatre bords.
Remarque : chacun de ces outils de transformation vous permettent de sélectionner 
et de repositionner des objets dans l’espace du Canevas.
L’outil Ajuster les points de contrôle est disponible lorsqu’une forme ou un masque 
est sélectionnée. Il vous sert à ajuster les points de contrôle de Bézier ou B-Spline. 
Quant à l’outil Ajuster l’élément, il est disponible lorsque l’élément sélectionné comporte 
des commandes à l’écran supplémentaires, tels qu’un filtre ou un générateur de dégradé.
Outil Sélectionner/Transformer
Outil Ajuster la déformation
Outil Ajuster les quatre angles
Outil Ajuster les points de contrôle
Outil Ajuster le point d’ancrage
Outil Ajuster l’ombre portée
Outil Ajuster le rognage
Outil Ajuster l’élément (les filtres ou les formes des émetteurs de particules)296 Chapitre 3 Compositing standard
Pour passer d’un outil de transformation à un autre, procédez de l’une 
des manières suivantes :
m Cliquez sur l’outil Sélectionner/Transformer dans la barre d’outils tout en maintenant 
le bouton de la souris enfoncé, puis choisissez un autre outil de transformation dans 
le menu local.
m Sélectionnez un objet dans le Canevas, puis appuyez sur la touche de tabulation. 
En appuyant sur cette touche, vous pouvez passer en revue les différents modes 
de transformation du Canevas dans l’ordre.
Remarque : appuyez simultanément sur les touches Maj + Tabulation pour parcourir 
les modes de transformation dans l’ordre inverse.
m Cliquez sur tout objet dans le Canevas tout en maintenant la touche Contrôle enfoncée, 
puis choisissez un mode de transformation dans le menu contextuel.Chapitre 3 Compositing standard 297
Pour en savoir plus sur les outils de transformation 3D, voir « compositing 3D » dans 
le manuel Motion Supplemental Documentation PDF.
Déplacement d’objets dans le Canevas
La manière la plus simple de disposer les objets dans votre projet consiste à les déplacer à l’endroit où vous le souhaitez. À l’exception de l’outil Ajuster l’ombre portée, 
tous les outils de transformation vous permettent de repositionner les objets, de sorte 
qu’il s’agit de la seule opération que vous puissiez effectuer indépendamment de l’outil 
de transformation sélectionné.
Pour déplacer un objet, il suffit de le faire glisser dans le Canevas à l’aide de la souris. 
Si vous souhaitez déplacer un objet avec beaucoup plus de précision, modifiez les 
valeurs numériques des paramètres de Position X et Y dans l’onglet Propriétés de 
l’Inspecteur. Pour en savoir plus sur les propriétés d’un objet, voir « Paramètres disponibles dans l’onglet Propriétés » à la page 312.
Utilisation des fonctions d’aide à la composition dans le Canevas
Lorsque vous disposez des objets directement dans le Canevas, n’hésitez pas à recourir 
aux différentes fonctions disponibles pour vous aider à organiser les objets de votre 
composition. Par exemple, si vous travaillez sur une séquence d’un film ou destinée 
à être diffusée, activez les zones sécurisées dans le Canevas afin d’éviter de placer 
des objets sur les limites de la zone de titre ou d’action sécurisée. Vous pouvez également activer la grille, les règles et les guides dynamiques afin d’aligner les objets avec 
plus de précision, en les utilisant comme points de repère. 
De plus, vous pouvez activer le magnétisme afin de vous aider à positionner des objets 
par rapport au centre ou aux bords du Canevas, avec ou sans les autres guides 
affichés à l’écran. 
Remarque : si vous souhaitez déplacer un objet n’importe où, appuyez sur la touche 
Commande pour désactiver momentanément le magnétisme.
Pour en savoir plus sur l’activation des différentes fonctions vous aidant à disposer 
les objets de votre composition dans le Canevas, voir « Affichage et incrustation » 
à la page 50.298 Chapitre 3 Compositing standard
Vous pouvez déplacer les objets n’importe où dans le Canevas mais également 
en dehors des limites du Canevas. Par défaut, lorsque vous déplacez un objet au-delà 
des limites de l’image, il devient invisible, mais vous pouvez toujours le manipuler 
par le biais de son cadre de sélection. 
Remarque : le cadre de sélection indiquant la position des objets en dehors du Canevas 
n’apparaît que lorsque ces objets sont sélectionnés.
Par exemple, il peut s’avérer nécessaire de déplacer un objet en dehors du Canevas 
lorsque vous envisagez d’animer un objet de façon à ce que celui-ci traverse l’écran. 
Pour réaliser cette animation, vous devez d’abord déplacer l’objet en dehors de l’écran.
Remarque : pour afficher l’intégralité d’un objet situé en partie ou en totalité à l’extérieur 
du Canevas, activez l’option « Afficher zone de présentation totale » dans le menu 
Présentation (situé juste au-dessus de la partie droite du Canevas).
Pour déplacer un ou plusieurs objets dans le Canevas :
1 Sélectionnez un ou plusieurs objets.
2 Procédez de l’une des manières suivantes :
Â Faites glisser un objet à l’endroit souhaité. Si plusieurs objets sont sélectionnés, 
il suffit de faire glisser un des objets sélectionnés pour tous les déplacer.
Â Appuyez sur la touche Commande, puis sur Flèche droite, Flèche gauche, Flèche 
vers le haut ou Flèche vers le bas pour repositionner tous les objets sélectionnés 
pixel par pixel. 
Â Appuyez sur les touches Commande + Maj, puis sur Flèche droite ou Flèche gauche 
pour repositionner votre sélection de 10 pixels.
Remarque : lorsque vous repositionnez de tout petits objets, il peut être nécessaire 
d’effectuer un zoom avant sur le Canevas pour les voir avec plus de précision.
Remarque : si vous appuyez sur la touche Flèche vers le haut ou vers le bas alors que 
vous travaillez dans le Canevas, la sélection passe à l’objet suivant (vers le haut ou vers 
le bas) dans l’onglet Couches.Chapitre 3 Compositing standard 299
Pour dupliquer un objet, procédez de l’une des manières suivantes :
m Sélectionnez l’objet à dupliquer, puis faites-le glisser tout en maintenant la touche 
Option enfoncée.
m Cliquez sur l’objet tout en maintenant la touche Option enfoncée, puis choisissez 
Dupliquer dans le menu contextuel.
Utilisation des commandes d’alignement d’objets
Plusieurs commandes du menu Objet peuvent servir à repositionner simultanément 
un nombre quelconque d’objets sélectionnés de plusieurs manières différentes. 
Ces commandes permettent d’aligner facilement et rapidement un groupe d’objets, 
vous évitant ainsi d’avoir à les aligner manuellement un par un.
Quelle que soit l’opération, les côtés gauche, droit, supérieur et inférieur des objets 
sélectionnés sont définis par le cadre de sélection qui les entoure. En ce qui concerne 
la position du point d’ancrage, elle n’est pas prise en compte.
Lorsque vous utilisez ces commandes, le paramètre Position correspondant est modifié 
automatiquement.
Aligner les bords gauches : les bords gauches des objets sont alignés sur l’objet situé 
le plus à gauche dans la sélection, sur un axe horizontal.
Aligner les bords droits : les bords droits des objets sont alignés sur l’objet situé 
le plus à droite dans la sélection, sur un axe horizontal.
Aligner les bords supérieurs : les bords supérieurs des objets sont alignés sur l’objet 
situé le plus haut dans la sélection, sur un axe vertical.
Aligner les bords inférieurs : les bords inférieurs des objets sont alignés sur l’objet 
situé le plus bas dans la sélection, sur un axe vertical.
Aligner les bords éloignés : les objets sont repositionnés sur l’axe Z, de telle sorte 
que leur bord le plus éloigné soit aligné sur l’objet situé le plus loin dans la sélection.
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Aligner les bords proches : les objets sont repositionnés sur l’axe Z, de telle sorte 
que leur bord le plus proche soit aligné sur l’objet situé le plus près dans la sélection.
Aligner les centres horizontalement : le centre des objets est aligné sur celui entre 
les objets les plus à gauche et ceux les plus à droite dans la sélection, formant ainsi 
une ligne horizontale.
Aligner les centres verticalement : le centre des objets est aligné sur le point central 
entre l’objet le plus haut et celui le plus bas dans la sélection, formant ainsi une ligne 
verticale.
Distribuer les bords gauches : les bords gauches de tous les objets sont distribués 
uniformément, de droite à gauche, entre les objets les plus à gauche et les plus à droite 
dans la sélection, formant ainsi une ligne horizontale.
Distribuer les bords droits : les bords droits de tous les objets sont distribués 
uniformément, de gauche à droite, entre les objets les plus à gauche et les plus 
à droite dans la sélection, formant ainsi une ligne horizontale.
Distribuer les bords supérieurs : les bords supérieurs de tous les objets sont distribués 
uniformément, de haut en bas, entre l’objet le plus haut et le plus bas dans la sélection, 
formant ainsi une ligne verticale.
Distribuer les bords inférieurs : les bords inférieurs de tous les objets sont distribués 
uniformément, de haut en bas, entre l’objet le plus haut et le plus bas dans la sélection, 
formant ainsi une ligne verticale.
Distribuer les bords éloignés : les objets sont repositionnés sur l’axe Z, de telle sorte 
que le bord le plus éloigné de chaque objet soit distribué uniformément le long de 
l’axe Z, du plus proche au plus éloigné, entre les objets situés le plus près et le plus 
loin dans la sélection.
Distribuer les bords proches : les objets sont repositionnés sur l’axe Z, de telle sorte 
que le bord le plus proche de chaque objet soit distribué uniformément le long de 
l’axe Z, du plus proche au plus éloigné, entre les objets situés le plus près et le plus 
loin dans la sélection.
Distribuer les centres horizontalement : le centre de tous les objets est distribué 
uniformément, de gauche à droite, entre les objets les plus à gauche et les plus à 
droite dans la sélection, formant ainsi une ligne horizontale.
Distribuer les centres verticalement : le centre de tous les objets est distribué 
uniformément, de haut en bas, entre l’objet le plus haut et le plus bas dans la sélection, 
formant ainsi une ligne verticale.
Distribuer les centres en profondeur : les objets sont repositionnés sur l’axe Z, de 
telle sorte que le centre de chaque objet soit distribué uniformément, du plus proche 
au plus éloigné, entre les objets situés le plus près et le plus loin dans la sélection.Chapitre 3 Compositing standard 301
Outils de transformation
Les commandes de transformation ont une double fonction. Via un seul mode, 
elles permettent à la fois de redimensionner (remettre à l’échelle) et de faire pivoter 
un objet.
Mise à l’échelle
Lorsque vous sélectionnez un objet, huit poignées d’échelle apparaissent sur le pourtour 
de son cadre de sélection. Faites glisser ces poignées pour redimensionner l’objet. 
Par défaut, la largeur et la hauteur d’un objet ne sont pas redimensionnées proportionnellement lorsque vous déplacez les poignées d’échelle. Vous pouvez donc modifier sans 
aucune limite les proportions d’un objet (par proportions, on entend le rapport largeur/
hauteur de l’objet). Pour préserver les proportions d’un objet, il vous suffit d’appuyer sur 
la touche Maj lorsque vous faites glisser ses poignées d’échelle. Les modifications apportées à l’échelle d’un objet s’appliquent également au paramètre Échelle de l’onglet Propriétés de l’Inspecteur.
Pour modifier séparément la largeur et la hauteur d’un objet dans le Canevas :
1 Cliquez sur un objet dans le Canevas pour le sélectionner. 
Si vous aviez activé un outre outil, tel que l’outil Masque, appuyez sur la touche S 
pour basculer vers les outils de transformation.
Un cadre de sélection apparaît autour de l’objet.
Remarque : vous pouvez également cliquer sur un objet dans le Canevas tout en maintenant la touche Contrôle enfoncée, puis choisir Transformer dans le menu contextuel.
Poignée d’échelle
Poignée de rotation
Point d’ancrage
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2 Procédez de l’une des manières suivantes :
Â Faites glisser l’une des poignées d’angle pour modifier simultanément la largeur 
et la hauteur de l’objet. Par défaut, vous pouvez modifier à volonté la largeur et 
la hauteur séparément.
Â Appuyez sur la touche Maj, puis faites glisser l’une des poignées d’angle pour 
redimensionner l’objet tout en verrouillant sa largeur et sa hauteur, ce qui permet 
de conserver ses proportions actuelles.Chapitre 3 Compositing standard 303
Â Faites glisser les poignées d’échelle supérieures ou inférieures pour limiter les changements d’échelle à la hauteur de l’objet. En revanche, faites glisser les poignées d’échelle 
gauche ou droite pour limiter les changements d’échelle à la largeur de l’objet.
Â Appuyez sur la touche Option tout en faisant glisser n’importe quelle poignée 
d’échelle pour redimensionner un objet autour de son point d’ancrage, plutôt 
que de le modifier de manière unilatérale.
Lorsque vous faites glisser les poignées d’échelle, une fenêtre d’information vous indique 
les nouveaux pourcentages correspondant à la largeur et à la hauteur, ainsi que les proportions dans lesquelles l’objet a été agrandi ou réduit. Cette dernière valeur est repré-
sentée par le symbole delta.
Faites glisser la poignée d’échelle de gauche 
pour modifier la largeur de l’objet.
Redimensionnement tout en maintenant 
la touche Option enfoncée
Redimensionnement sans maintenir la touche 
Option enfoncée304 Chapitre 3 Compositing standard
Remarque : l’application d’une valeur négative lors de la mise à l’échelle de la largeur 
ou de la hauteur d’un objet a pour effet d’inverser l’image, ainsi que sa direction.
Rotation
Une autre poignée de transformation vous permet de faire pivoter l’image autour de 
son point d’ancrage. Pour des questions de suivi de votre animation, Motion conserve 
le nombre de fois où vous avez fait pivoter un objet et stocke ce nombre dans le paramètre Rotation de l’onglet Propriétés de l’Inspecteur.
Pour faire pivoter un objet dans le Canevas :
1 Cliquez sur un objet dans le Canevas pour le sélectionner.
Remarque : le mode Sélectionner/Transformer est activé par défaut à l’ouverture 
de Motion.
2 Procédez de l’une des manières suivantes :
Â Faites glisser la poignée de rotation pour faire pivoter l’objet. 
Â Appuyez sur la touche Maj tout en faisant glisser la poignée de rotation pour limiter 
l’angle de rotation de l’objet sélectionné à des incréments de 45 degrés.
Lorsque vous faites glisser la poignée de rotation, l’angle d’origine de l’objet est indiqué 
par un petit cercle, entouré lui-même d’un plus grand cercle autour du point d’ancrage 
de l’objet. Qui plus est, une fenêtre d’information apparaît pour vous indiquer le nouvel 
angle de rotation et la différence entre l’angle précédent de l’objet et l’angle selon 
lequel vous l’avez fait glisser.Chapitre 3 Compositing standard 305
Modification du point d’ancrage d’un objet
En déplaçant le point d’ancrage de n’importe quel objet, vous modifiez les différents 
types de transformation géométrique. Les objets tournent autour de leur point d’ancrage, 
qui a également un effet sur les opérations de déformation et de redimensionnement.
Par exemple, le point d’ancrage par défaut de tout objet correspond au centre du cadre 
de sélection qui définit les bords de l’objet. La rotation de tout objet a lieu autour de 
ce point d’ancrage central.
Si vous déplacez le point d’ancrage d’un objet, ce dernier ne pivote plus autour de son 
propre centre, mais autour du nouveau point d’ancrage.
Le déplacement du point d’ancrage n’a pas seulement un effet sur la rotation d’un objet, 
c’est également le cas sur les opérations de déplacement et d’échelle réalisées sur l’objet. 
Les modifications apportées au point d’ancrage d’un objet sont conservées dans 
le paramètre Point d’ancrage de l’onglet Propriétés de l’Inspecteur.306 Chapitre 3 Compositing standard
Pour modifier le point d’ancrage d’un objet dans le Canevas :
1 Cliquez sur l’outil Sélectionner/Transformer tout en maintenant le bouton de la souris 
enfoncé, puis choisissez l’outil Ajuster le point d’ancrage dans le menu local.
Dans le Canevas, le point d’ancrage d’un objet est symbolisé par une cible ronde 
entourée de trois flèches de couleur représentant les axes de coordonnées X, Y et Z. 
Pour en savoir plus sur les axes de coordonnées, voir « compositing 3D » dans le 
manuel Motion Supplemental Documentation PDF.
2 Procédez de l’une des manières suivantes :
Â Faites glisser le cercle blanc pour déplacer le point d’ancrage à la verticale 
ou à l’horizontale.
Â Faites glisser l’une des flèches pour déplacer le point d’ancrage le long de l’axe 
correspondant.
Lorsque vous faites glisser le point d’ancrage, une ligne apparaît, s’étirant de la position 
par défaut du point d’ancrage jusqu’à sa nouvelle position. De plus, une fenêtre d’information vous indique en haut les nouvelles coordonnées du point d’ancrage, ainsi que 
la différence (le delta) entre la nouvelle et l’ancienne position du point d’ancrage.
Remarque : si le point d’ancrage est situé à proximité du centre ou d’un des bords de 
l’objet et que vous avez activé les Guides dynamiques, il se positionne par magnétisme 
sur cette position.
Déformation d’objets
Les poignées de déformation peuvent être utilisées pour incliner un objet horizontalement 
ou verticalement. Il s’agit d’une représentation isométrique de l’objet, c’est pourquoi 
l’effet de perspective n’est pas nécessairement réaliste. Lorsque vous déformez un objet, 
cette modification est conservée dans le paramètre Déformer, dans l’onglet Propriétés 
de l’Inspecteur.
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Pour déformer un objet dans le Canevas :
1 Cliquez sur l’outil Sélectionner/Transformer tout en maintenant le bouton de la souris 
enfoncé, puis choisissez l’outil Ajuster la déformation dans le menu local.
2 Dans le Canevas, faites glisser l’une des quatre poignées de déformation pour incliner 
l’objet. Les poignées supérieures et inférieures inclinent l’objet horizontalement. Quant 
aux poignées gauche et droite, elles l’inclinent verticalement.
Ajustement de l’ombre portée d’un objet
Dès que le paramètre Ombre portée d’un objet est activé, des poignées d’ombre portée 
apparaissent à l’écran pour modifier le flou, l’angle et la distance de l’ombre portée 
de cet objet.
Pour ajuster l’ombre portée d’un objet dans le Canevas :
1 Cliquez sur l’outil Sélectionner/Transformer tout en maintenant le bouton de la souris 
enfoncé, puis choisissez l’outil Ajuster l’ombre portée dans le menu local.
2 Dans le Canevas, faites glisser l’une des quatre poignées d’angle afin d’ajuster le flou 
de l’ombre portée.
Faites glisser la zone de sélection de l’ombre afin d’ajuster la distance et l’angle de 
l’ombre portée.
Pour en savoir plus sur l’utilisation des ombres portées, consultez la rubrique « Ombres 
portées » à la page 342.
Ombre portée par défaut (avant l’utilisation 
de l’outil Ajuster l’ombre portée)
Après l’ajustement du flou, de l’angle 
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Déformation des objets par les angles
Les commandes Quatre angles vous offrent la possibilité d’étirer un objet en vue de lui 
donner différentes formes polygonales. Vous pouvez ainsi donner l’illusion d’une perspective, ainsi que simuler des effets 3D et des positions dans un espace tridimensionnel 
au sein de votre composition.
Pour déformer un objet par les angles dans le Canevas :
1 Cliquez sur l’outil Sélectionner/Transformer tout en maintenant le bouton de la souris 
enfoncé, puis choisissez l’outil Ajuster les quatre angles dans le menu local.
2 Dans le Canevas, faites glisser chacune des quatre poignées d’angle pour étirer l’objet 
jusqu’à obtenir la forme souhaitée.
Remarque : comme avec les poignées d’échelle, vous pouvez inverser les poignées 
d’angle pour retourner l’image. Cependant, en faisant pivoter l’un des quatre angles 
de 180 degrés, vous risquez d’obtenir des résultats inattendus.
Après avoir déformé un objet par les angles, il vous suffit de désactiver la case Quatre 
angles dans l’onglet Propriétés de l’Inspecteur pour revenir à la forme d’origine. 
L’objet retrouve alors sa forme d’origine. Toutefois, la forme déformée par les angles, 
définie dans le paramètre Quatre angles de l’onglet Propriétés, est conservée.
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Rognage d’objets
Le rognage consiste à réduire un ou plusieurs bords d’un objet afin d’éliminer les parties 
que vous ne souhaitez plus voir dans votre composition. Les exemples les plus courants 
concernent souvent la suppression de la bande noire située sur le bord gauche ou droit 
d’un plan vidéo du fait du format vidéo ou encore du cercle sombre de vignetage 
apparaissant sur les bords lorsque vous utilisez un objectif grand angle. Vous pouvez 
utiliser l’outil Rognage pour éliminer les artefacts indésirables lorsque vous souhaitez 
les utiliser dans votre composition. Il est également possible de rogner un objet pour 
isoler un élément de l’image, dès lors que cet élément peut être découpé en traçant 
un simple rectangle.
Remarque : si vous devez isoler un objet ayant une forme plus irrégulière ou que vous 
souhaitez créer une bordure d’une certaine forme, consultez la rubrique « Utilisation 
des formes et des masques » à la page 1071 pour en savoir plus.
Comparaison entre le rognage dans l’Inspecteur et dans l’onglet Média
Lorsque vous rognez une image importée à l’aide de l’outil de transformation à l’écran 
(ce qui revient à utiliser les commandes Rogner dans l’onglet Propriétés de l’objet), 
seule l’instance de ce fichier est rognée. L’image source dans l’onglet Média n’est pas 
rognée. Pour rogner l’image source, vous devez sélectionner l’objet sous l’onglet 
Média de la sous-fenêtre Projet, puis utiliser les outils Rogner sous l’onglet Média 
de l’Inspecteur. Pour en savoir plus, consultez la rubrique « Paramètres d’objet dans 
l’onglet Média » à la page 250.
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Pour rogner un objet dans le Canevas :
1 Cliquez sur l’outil Sélectionner/Transformer tout en maintenant le bouton de la souris 
enfoncé, puis choisissez l’outil Ajuster le rognage dans le menu local.
2 Dans le Canevas, faites glisser l’une des huit poignées situées le long du bord de l’objet 
afin de le rogner :
Â Faites glisser la poignée supérieure, inférieure, gauche ou droite pour ne rogner 
que ce côté.
Â Faites glisser une des quatre poignées pour rogner deux côtés à la fois.
Â Faites glisser une poignée d’angle tout en appuyant sur la touche Maj pour limiter 
le rognage au rapport largeur/hauteur de l’objet.
Remarque : après avoir déformé un objet par les angles, vous ne pouvez plus activer 
le mode Rognage dans le Canevas (commandes à l’écran). En revanche, il y a toujours 
possibilité de rogner un objet déformé par les angles en ajustant les réglages du paramètre Rognage dans l’onglet Propriétés de l’Inspecteur.
De plus, vous pouvez manipuler séparément la zone rognée et l’image.
Pour déplacer la zone rognée sans toucher à l’image sous-jacente :
m Appuyez sur les touches Commande et Option tout en faisant glisser la zone rognée.
Pour déplacer l’image sans toucher à la zone rognée :
m Appuyez sur la touche Commande tout en faisant glisser la zone rognée.
Ajustement des points de contrôle
Vous pouvez modifier une forme ou un masque directement dans le Canevas.
Pour modifier les points de contrôle d’une forme dans le Canevas :
1 Une fois la forme ou le masque créé, cliquez sur l’outil Sélectionner/Transformer tout 
en maintenant le bouton de la souris enfoncé, puis choisissez l’outil Ajuster les points 
de contrôle dans le menu local.
Remarque : vous pouvez également double-cliquer sur la forme ou cliquer sur l’objet 
tout en maintenant la touche Contrôle enfoncée, puis choisir Ajuster les points de contrôle 
dans le menu contextuel, afin d’accéder au mode d’ajustement des points de contrôle.
Les points de contrôle de l’objet deviennent actifs.Chapitre 3 Compositing standard 311
2 Dans le Canevas, faites glisser ces points pour modifier la forme de l’objet.
Pour en savoir plus sur l’utilisation de formes et de masques, consultez la rubrique 
« Utilisation des formes et des masques » à la page 1071.
Commandes de géométrie d’un objet dans l’Inspecteur
Les groupes et les objets disposent des mêmes paramètres géométriques dans l’onglet 
Propriétés de l’Inspecteur. L’ajustement d’une commande de transformation du Canevas 
modifie également le paramètre correspondant dans l’onglet Propriétés de l’Inspecteur. 
Si vous souhaitez transformer un objet avec plus de précision qu’avec les commandes 
à l’écran, modifiez directement la valeur numérique du paramètre. 
Lorsque vous sélectionnez un seul objet et que vous ouvrez l’onglet Propriétés de l’Inspecteur, les paramètres de l’objet s’affichent. Vous pouvez modifier l’objet sélectionné 
en modifiant les valeurs de l’onglet Propriétés. Si vous avez sélectionné plusieurs objets 
dans le Canevas, la Timeline ou l’onglet Couches, les valeurs des paramètres affichés 
par l’onglet Propriétés de l’Inspecteur deviennent accessibles. Toutefois, vous pouvez 
toujours utiliser les commandes à l’écran. Tous les objets sélectionnés sont modifiés à 
l’identique lorsque vous manipulez n’importe laquelle des poignées de transformation 
à l’écran.
Pour modifier les valeurs des paramètres dans l’onglet Propriétés de l’Inspecteur, 
procédez de l’une des manières suivantes :
m Sélectionnez le champ de valeur d’un paramètre, saisissez une nouvelle valeur, 
puis appuyez sur Retour.
m Si le paramètre est doté d’une commande graphique, par exemple un curseur 
ou un cadran, utilisez cette commande pour ajuster le paramètre.
m Pour qu’un paramètre reprenne sa valeur par défaut, cliquez sur le bouton de réinitialisation correspondant ou sélectionnez Réinitialiser le paramètre à partir du menu 
Animation du paramètre.
Pour en savoir plus sur l’utilisation des commandes des paramètres, voir « Types de 
commandes » à la page 138.312 Chapitre 3 Compositing standard
Paramètres disponibles dans l’onglet Propriétés
L’onglet Propriétés affiche les paramètres suivants pour la majeure partie des objets 
et des groupes :
Position : définit la position X (horizontale), Y (verticale) et Z (profondeur) de chaque objet.
Le système de coordonnées utilisé par Motion affecte la valeur 0, 0, 0 au centre du 
Canevas, quelles que soient les dimensions de l’image de votre projet. Le déplacement 
d’un objet vers la gauche a pour effet de diminuer sa valeur X, alors que son déplacement 
vers la droite l’augmente. De la même façon, le déplacement d’un objet vers le haut a 
pour effet d’augmenter sa valeur Y, alors que son déplacement vers le bas la diminue. 
Enfin, rapprocher un objet augmente sa valeur Z, alors que l’éloigner la diminue.
Remarque : Final Cut Pro et Final Cut Express HD utilisent le même système de coordonnées. En revanche, il diffère du système de Shake, dans lequel les coordonnées 0,0 
correspondent à l’angle supérieur gauche de la zone de composition.
La position de chaque objet est centrée sur son point d’ancrage. Le décalage de 
ce point d’ancrage décale également la position de l’objet par rapport aux valeurs 
des coordonnées X, Y et Z que vous avez définies.
Rotation : contrôle une valeur à une seule dimension, soit la valeur de la rotation 
en degrés. Une valeur positive a pour effet de faire pivoter l’objet vers la gauche. 
En revanche, une valeur négative fait pivoter l’objet vers la droite.
Un angle de rotation supérieur à 360 degrés entraîne plusieurs rotations lorsque 
le paramètre Rotation est animé.
Cliquez sur le triangle d’affichage en regard du paramètre Rotation afin de révéler 
des sous-paramètres supplémentaires :
Point central du canevas
(0, 0)
-360 pixels +360 pixels
+240 pixels
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Â Animer: ce menu local vous permet de régler l’interpolation des canaux de rotation 
3D animés sur l’une des deux options suivantes :
Remarque : pour que les options du paramètre Animer aient le moindre effet, 
le paramètre Rotation doit être animé avec des images clés.
Â Utiliser la rotation : méthode d’interpolation par défaut. Les éléments du motif 
pivotent de leur rotation de départ vers leur rotation finale. Selon l’animation, 
ces éléments risquent de subir diverses torsions avant d’atteindre leur orientation 
finale (la dernière valeur d’image clé). Par exemple, si les paramètres Angle X, Y et Z 
sont animés dans un projet de 0 à 180 degrés, les éléments pivotent sur tous les axes 
avant d’atteindre leur orientation finale.
Â Utiliser l’orientation : cette autre méthode d’interpolation est plus lisse, 
mais elle n’autorise pas de multiples révolutions. Elle applique une interpolation 
entre l’orientation de départ des éléments du motif (première image clé) et leur 
orientation finale (deuxième image clé).
Échelle : contrôle le pourcentage d’échelle de l’objet, calculé à partir de la taille d’origine. 
Par défaut, l’échelle horizontale et verticale d’un objet est verrouillée sur le rapport 
largeur/hauteur d’origine de l’objet et est indiquée par un seul pourcentage. 
Cliquez sur le triangle d’affichage pour afficher des pourcentages distincts pour 
les échelles X, Y et Z de l’objet.
Remarque : le réglage de l’échelle de l’objet sur une valeur négative a pour effet 
de retourner l’objet.
Déformer : définit les valeurs de déformation X et Y de l’objet. Un objet sans déformation a 0 comme valeurs de déformation X et Y. Une valeur positive a pour effet de 
déformer l’objet dans un sens, et une valeur négative le déforme dans l’autre sens.
Point d’ancrage : définit les coordonnées X, Y et Z du point d’ancrage par rapport 
au centre de l’objet. Les coordonnées 0, 0, 0 centrent le point d’ancrage dans le cadre 
de sélection, délimitant ainsi le bord extérieur de l’objet.
Opacité : définit la transparence de l’objet. Pour en savoir plus, consultez la rubrique 
« Modification de l’opacité et de la fusion » à la page 317.
Mode de fusion : détermine le mode de fusion de l’objet. Pour en savoir plus, consultez 
la rubrique « Modification de l’opacité et de la fusion » à la page 317.314 Chapitre 3 Compositing standard
Conserver l’opacité : lorsque cette case est cochée, l’objet apparaît uniquement si 
un autre objet est visible derrière dans le montage composite. L’objet au premier plan 
utilise la valeur d’opacité de l’objet situé au-dessous. Pour en savoir plus, consultez 
la rubrique « Option Conserver l’opacité » à la page 321.
Ombre portée : active ou désactive l’ombre portée d’un objet. Pour en savoir plus sur 
l’utilisation d’ombres portées, consultez la rubrique « Ombres portées » à la page 342.
Quatre angles : active ou désactive la déformation par les angles. Si un objet a été 
déformé par les angles et que vous désactivez la case Quatre angles, l’objet retrouve 
sa forme d’origine. En revanche, les coordonnées de déformation par les angles sont 
conservées. Sélectionnez à nouveau cette case pour réactiver l’effet de déformation 
par les angles spécifié par les paramètres de coordonnées Quatre angles.
Cliquez sur le triangle d’affichage pour afficher les quatre paramètres 2D qui définissent 
la transformation en polygone d’un objet déformé par les angles. Les paramètres individuels des angles inférieur gauche, inférieur droit, supérieur droit et supérieur gauche 
du cadre de sélection d’un objet ont chacun leurs propres coordonnées X et Y.
Rognage : active ou désactive le rognage. Si un objet a été rogné et que vous désactivez 
la case Rognage, l’objet retrouve sa forme d’origine. En revanche, les valeurs de rognage 
sont conservées. Sélectionnez à nouveau cette case pour réactiver l’effet de rognage 
spécifié par les paramètres de rognage.
Paramètre Préserver l’opacité désactivé pour 
l’objet cercle de texte
Paramètre Préserver l’opacité activé pour l’objet 
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Cliquez sur le triangle d’affichage pour afficher les quatre paramètres de rognage. 
Chaque paramètre définit le nombre de pixels à rogner sur chacun des quatre bords 
de l’objet par rapport au bord extérieur du cadre de sélection situé autour de l’objet. 
Ces paramètres sont identiques aux paramètres de rognage qui apparaissent lorsqu’un 
objet est sélectionné dans l’onglet Média. En revanche, le rognage d’un objet dans 
l’onglet Couches ne rogne que l’occurrence de l’objet sélectionnée dans votre projet. 
Les copies de l’objet restent intactes. Pour rogner toutes les occurrences de l’objet simultanément, utilisez le paramètre Rognage sur l’objet dans l’onglet Média. Pour en savoir 
plus, consultez la rubrique « Paramètres d’objet dans l’onglet Média » à la page 250.
Contrôle du temps : ces paramètres contrôlent tous les aspects relatifs à la resynchronisation d’un plan. Pour en savoir plus, consultez la rubrique « Resynchronisation » à la 
page 345.
Clonage de couches
Dans un projet d’animation, il s’avère parfois nécessaire de réutiliser plusieurs fois 
un objet complexe en divers endroits. Même si vous avez la possibilité de dupliquer 
ou de couper-coller un objet, aucune des modifications apportées par la suite à l’original n’est mise à jour dans ses copies. Le suivi de telles manipulations peut vite devenir 
une tâche fastidieuse et compliquée. Si vous êtes amené à appliquer les mêmes filtres 
et masques à plusieurs copies d’un même objet, la commande Cloner la couche est 
faite pour vous. Le clonage des couches présente en outre l’avantage d’améliorer 
la lecture du projet et les performances de rendu.
Pour créer une couche clonée, procédez de l’une des manières suivantes :
m Sélectionnez l’objet à partir duquel vous souhaitez créer une couche clonée, 
puis choisissez Objet > Cloner la couche.
m Cliquez sur un objet dans le Canevas tout en maintenant la touche Contrôle enfoncée, 
puis choisissez Cloner la couche dans le menu contextuel.
m Cliquez sur un objet dans l’onglet Couches ou la liste de couches de la Timeline tout 
en maintenant la touche Contrôle enfoncée, puis choisissez Cloner la couche dans 
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Une couche clonée est créée et elle apparaît au centre du Canevas. Dans la liste 
de couches, la couche clonée est affichée avec son nom par défaut « Couche clonée ». 
Une icône de couche clonée apparaît en regard de son nom.
Remarque : si l’objet source est situé au centre du Canevas, les deux objets se chevauchent.
La couche clonée hérite de certaines propriétés de son objet source au moment de sa 
création : Rotation, Échelle, Opacité, Mode de fusion et Ombre portée. Toute modification 
apportée à l’une de ces propriétés de l’objet source après la création de couches clonées 
n’est pas transmise aux clones de cet objet source. En effet, les couches clonées héritent uniquement des modifications effectuées sur les filtres et les masques de l’objet 
source.
Important : les modifications sur les comportements ne sont pas transmises aux couches 
clonées, sauf si les comportements concernés affectent un filtre ou un masque de 
l’objet source.
Manipulez les couches clonées dans le Canevas et la Timeline exactement comme 
s’il s’agissait d’un objet source.
Important : le paramètre Fusion d’images d’une couche clonée à partir d’objets 
resynchronisés ne peut être différent de celui de son objet source.
Vous pouvez créer des couches clonées à partir de couches, de groupes, de systèmes 
de particules, de texte, de formes et de réplicateurs.
Couches clonées et tramage
Certaines opérations, tout comme l’application de divers filtres ou d’un masque, provoquent le tramage d’une couche clonée. Ce tramage convertit la couche clonée en image 
bitmap. Le mode de fusion appliqué à une couche clonée n’a aucune interaction avec 
les objets situés en dehors du groupe contenant cette couche clonée. De plus, une couche clonée 3D est traitée comme un objet unique et elle utilise l’ordre des couches 
(dans l’onglet Couches), plutôt que l’ordre de profondeur, pour composer le projet.
Pour en savoir plus sur le tramage et les couches clonées 3D, voir « compositing 3D » 
dans le manuel Motion Supplemental Documentation PDF.Chapitre 3 Compositing standard 317
Remarque : les caméras et les lumières utilisées dans un projet ont une incidence sur 
les couches clonées.
Pour en savoir plus sur le tramage dans des groupes, voir « À propos du tramage » 
à la page 320. 
Modification de l’opacité et de la fusion
Les commandes d’opacité et de fusion de chaque objet apparaissent à la fois dans 
l’onglet Propriétés de l’Inspecteur et dans la palette par défaut, quel que soit l’objet 
sélectionné.
Opacité
En superposant plusieurs objets avec des opacités différentes, vous pouvez les fusionner, 
ce qui serait impossible autrement. Par exemple, si vous souhaitez utiliser ensemble 
deux images d’arrière-plan remplissant tout l’écran, vous pouvez définir l’opacité de 
l’objet au premier plan sur 50 %, permettant ainsi à l’objet en arrière-plan d’être visible.
Vous pouvez superposer autant d’objets que vous le souhaitez et dévoiler plus 
ou moins les objets en arrière-plan en variant l’opacité de chaque objet.
Pour modifier l’opacité d’un objet, procédez de l’une des façons suivantes :
m Ajustez le curseur Opacité ou le curseur de valeur dans l’onglet Propriétés.
m Ajustez le curseur Opacité dans la palette.
Modes de fusion
Alors que le paramètre d’opacité définit simplement un niveau uniforme de transparence d’un objet, les modes de fusion offrent des options plus créatives permettant de 
contrôler l’interaction des images superposées, et ce en fonction des couleurs de chaque objet. Par défaut, le mode de fusion de chaque objet est réglé sur Normal, ce qui 
signifie que les modifications apportées à l’opacité d’un objet sont appliquées de 
manière uniforme sur toute l’image.
Image au premier plan Image en arrière-plan Image au premier plan avec 
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Les modes de fusion peuvent créer des zones transparentes sur un objet quelle 
que soit la valeur de son paramètre d’opacité. Cela s’explique par le fait que les pixels 
d’une image pour laquelle un mode de fusion a été sélectionné ont été fusionnés 
avec les pixels de tout objet se trouvant juste en dessous dans le Canevas. Par exemple, 
si vous avez superposé deux objets, puis défini le mode de fusion de l’objet supérieur 
sur Superposition, les zones sombres de l’image superposée deviennent transparentes. 
Quant aux zones claires, elles deviennent plus unies. Voir l’image ci-dessous :
Important : la transparence créée à l’aide de la plupart des modes de fusion disponibles 
affecte uniquement la façon dont un objet est combiné avec les objets superposés 
situés en dessous. Ces modes de fusion ne modifient en rien le canal alpha de l’objet. 
Pour en savoir plus sur les modes de fusion qui modifient le canal alpha d’un objet, 
voir « Modes de fusion ayant un impact sur les canaux alpha » à la page 340.
Chaque mode de fusion permet de fusionner les objets différemment. Par exemple, 
lorsque vous réglez le mode de fusion de l’objet supérieur sur Multiplier, vous obtenez 
un résultat opposé au mode Superposition, car les zones plus sombres de l’image restent 
opaques et les zones plus claires deviennent transparentes.Chapitre 3 Compositing standard 319
Les modes de fusion ne s’appliquent qu’à un objet fusionné avec ceux situés sous celui-ci. 
Tout objet situé au-dessus n’a aucun effet sur cette interaction, même s’il est transparent. 
Dans l’exemple qui suit, les objets texte situés au niveau supérieur n’ont aucun effet 
sur les images fusionnées se trouvant en dessous.
Dans le cas de couches superposées ayant chacune un mode de fusion différent, les deux 
objets situés tout en bas sont fusionnés en premier, puis le résultat obtenu est fusionné 
avec l’objet situé juste au-dessus, et ainsi de suite, jusqu’à ce que tous les objets superposés aient été fusionnés pour obtenir une image finale. De plus, chaque objet ayant un 
mode de fusion différent, il n’interagit qu’avec l’image inférieure (qu’elle soit composée 
d’un seul objet ou de deux objets fusionnés).
Chaque mode de fusion dans Motion agit en parallèle sur le paramètre Opacité afin 
de modifier l’interaction entre les objets situés au premier plan et ceux en arrière-plan. 
En ajustant l’opacité d’un objet, l’effet de fusion appliqué à l’objet est diminué, même 
si l’objet risque d’être moins visible. Cela vous permet de personnaliser au mieux tout 
mode de fusion.
Les modes de fusion modifient uniquement les objets superposés et n’ont aucun effet sur 
la couleur d’arrière-plan de votre projet. Si vous spécifiez un mode de fusion d’un objet 
non superposé à quoi que ce soit, l’objet n’est pas modifié.
Pour modifier le mode de fusion d’un objet sélectionné, procédez de l’une 
des manières suivantes :
m Choisissez une option dans le menu local Mode de fusion de la palette.
m Sélectionnez une option dans le menu local Mode de fusion de l’onglet Propriétés.
m Choisissez Objet > Mode de fusion, puis sélectionnez une option dans le sous-menu.
m Affichez la colonne Mode de fusion dans l’onglet Couches, puis sélectionnez une 
option dans le menu local Mode de fusion de l’objet.
m Cliquez sur un objet dans le Canevas tout en maintenant la touche Contrôle enfoncée, 
puis choisissez une option dans le sous-menu Mode de fusion du menu contextuel.
m Cliquez sur un objet dans l’onglet Couches ou la liste de couches de la Timeline tout en 
maintenant la touche Contrôle enfoncée, puis choisissez une option dans le sous-menu 
Mode de fusion du menu contextuel.320 Chapitre 3 Compositing standard
À propos du tramage
Certaines opérations, tout comme l’application de divers filtres ou d’un masque, provoquent le tramage du groupe concerné. Lorsqu’il est tramé, un groupe est converti 
en image bitmap. Ce tramage affecte les groupes 2D et 3D différemment. Lorsqu’un 
groupe 2D est tramé, les modes de fusion appliqués aux objets au sein du groupe 
n’ont plus aucune interaction avec les objets situés en dehors du groupe. Par ailleurs, 
si un groupe 3D est tramé, l’intégralité du groupe ne peut plus avoir aucune interaction avec les objets situés en dehors. Le groupe 3D tramé est alors traité comme un 
objet unique et il utilise l’ordre des couches (dans l’onglet Couches), plutôt que l’ordre 
de profondeur, pour composer le projet.
Remarque : même si un groupe 3D est tramé, les caméras et les lumières utilisées dans 
le projet ont toujours une interaction avec les objets situés au sein de ce groupe. 
Pour en savoir plus sur le tramage et les groupes 3D, voir « compositing 3D » dans 
le manuel Motion Supplemental Documentation PDF.
Important : l’éclairage utilisé au sein d’un groupe 2D ne sort pas des limites 
de ce groupe, qu’il soit tramé ou non.
La modification des paramètres suivants déclenche le tramage d’un groupe :
Groupes 2D
Â Modification des paramètres de fusion (Opacité, Mode de fusion, Conserver l’opacité)
Â Activation de l’option Ombre portée
Â Activation de l’option Quatre angles
Â Activation de l’option Rognage
Â Application de n’importe quel filtre
Â Ajout d’un masque
Â Ajout d’une table lumineuse
Groupes 3D
Â Modification des paramètres de fusion
Â Application de certains filtres
Â Ajout d’une table lumineuse à un groupe 3D dont le paramètre Aplatir est activé 
(dans l’onglet Groupe de l’Inspecteur)
Une fois le tramage déclenché par l’une de ces opérations, les événements suivants 
surviennent :
Â Un indicateur de tramage (semblable à un voyant) apparaît en regard du paramètre 
dans l’onglet Propriétés.
Â Un contour léger apparaît autour de l’icône représentant le groupe 2D ou 3D 
(à gauche de son nom) dans l’onglet Couches et la liste de couches de la Timeline.Chapitre 3 Compositing standard 321
Option Conserver l’opacité
La case Conserver l’opacité permet de limiter la visibilité d’un objet aux zones du Canevas 
où il est superposé à des zones non transparentes d’autres objets. Par exemple, vous 
pouvez placer deux objets superposés dans votre projet, comme illustré ci-dessous :
Si vous cochez la case Conserver la transparence pour l’objet au premier plan 
représentant un dauphin, le résultat est le suivant :
Le dauphin n’est alors visible que dans la partie superposée à l’objet situé en dessous 
et qui représente la vie sous-marine. Au premier abord, cette option ne semble pas 
très utile. Vous pouvez toutefois créer des effets très intéressants en associant l’option 
Conserver l’opacité au mode de fusion et à l’opacité.
Remarque : un objet dont l’option Conserver l’opacité est activée utilise la valeur 
d’opacité de l’objet situé en dessous dans la pile de montage composite. 322 Chapitre 3 Compositing standard
L’option Conserver l’opacité est une manière simple de ne rendre visible que certaines 
parties d’un objet. Dans l’exemple ci-dessous, l’image a été obtenue en réglant le mode 
de fusion de la couche multicolore supérieure sur Exclusion :
Lorsque vous activez l’option Conserver l’opacité pour la couche multicolore supérieure, 
seules les parties superposées sont affichées et l’image en surimpression ne modifie 
que la couche représentant le dauphin.
Pour activer l’option Conserver l’opacité :
m Cochez la case Conserver l’opacité dans l’onglet Propriétés.
Utilisation des modes de fusion
Chaque mode de fusion disponible présente une méthode différente pour combiner 
plusieurs images. Les modes de fusion s’utilisent parallèlement avec la canal alpha 
d’un objet et le paramètre d’opacité.
Effets des modes de fusion sur les images
Pour comprendre la description de chaque mode de fusion dans cette section, il est 
important de comprendre que les modes de fusion mélangent les couleurs des images 
superposées, en tenant compte de la luminosité de chaque canal de couleur d’une 
image. Chaque image est composée des canaux alpha, rouge, vert et bleu. En parallèle, 
chaque canal contient une plage de valeurs de luminosité qui définit l’intensité de 
chaque pixel de l’image utilisant une partie de ce canal de couleur.Chapitre 3 Compositing standard 323
L’effet de chaque mode de fusion sur les objets superposés dans le Canevas dépend 
donc des valeurs de la plage de couleurs au sein de chaque objet. Les canaux rouge, 
vert et bleu de chaque pixel superposé sont fusionnés mathématiquement pour obtenir 
l’image finale.
Ces plages de valeur correspondent aux noirs, aux valeurs intermédiaires ou aux blancs. 
Les segments de couleurs sont largement illustrés dans le graphique ci-dessous.
Par exemple, le mode de fusion Multiplier rend transparentes les couleurs se trouvant 
dans les zones blanches et laisse intactes les zones noires de l’image. Quant aux couleurs 
intermédiaires, elles deviennent translucides (les couleurs les plus claires de la gamme 
deviennent plus transparentes que les couleurs les plus sombres de la gamme).
Modes de fusion des groupes
Les modes de fusion ont des effets différents selon que vous les appliquez à des groupes 
ou à des couches. Le mode Au travers, notamment, n’est disponible que pour les groupes.
Mode Au travers
Lorsque le mode de fusion d’un groupe est défini sur Au travers, chaque objet est 
fusionné individuellement avec tous les objets et les groupes répertoriés en dessous 
de son niveau hiérarchique dans l’onglet Couches. Dans cet exemple, l’objet Tourbillons 
est défini sur Stencil luma et l’objet Poissons sur Ajouter.
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L’option Au travers étant activée au niveau du groupe d’imbrication, l’objet Tourbillons 
marque au pochoir tous les autres objets situés en dessous de son niveau, y compris 
l’objet Dégradé listé tout en bas du groupe. Le résultat obtenu est celui d’objets tracés 
sur la couleur d’arrière-plan. Les objets Poissons sont également ajoutés à la pile 
d’objets fusionnés.
Normal
Lorsque le mode de fusion d’un groupe est défini sur Normal, les couches imbriquées 
à l’intérieur peuvent uniquement fusionner les unes avec les autres. Elles ne sont pas 
en mesure de fusionner avec des objets au sein d’autres groupes situés plus bas dans 
la liste de couches.
Dans cet exemple, les objets Poissons et Tourbillons situés tout en haut du groupe 
sont uniquement fusionnés ensemble, si le groupe de niveau supérieur est réglé sur 
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L’objet Dégradé situé tout en bas du groupe n’est pas affecté, même si la transparence 
du groupe de niveau supérieur provoquée par la combinaison des modes de fusion 
Ajouter et Stencil luma le révèle à l’arrière-plan.
Autres modes de fusion
Lorsque vous appliquez l’un des autres modes de fusion disponibles à un groupe, chaque couche imbriquée au sein de ce groupe est fusionnée selon son propre mode. 
L’image obtenue est ensuite fusionnée avec les groupes de niveau inférieur, conformé-
ment au mode de fusion sélectionné pour chaque groupe. Dans cet exemple, le groupe 
situé tout en haut est défini sur Multiplier.
Par conséquent, la combinaison des objets Poissons ajoutés et Tourbillons marqués 
au pochoir est multipliée par l’objet Dégradé dans le groupe de niveau inférieur.326 Chapitre 3 Compositing standard
Modes de fusion des objets
La section suivante décrit les effets des modes de fusion sur des objets individuels. 
Tous les modes de fusion sont présentés dans le même ordre que celui du menu local 
Mode de fusion.
Normal
Ce mode de fusion est sélectionné par défaut pour tous les objets. Le seul effet 
de transparence dans un objet dont le mode de fusion est réglé sur Normal est 
dû à son paramètre Opacité ou au canal alpha qui lui est affecté.
Soustraire
Le mode de fusion Soustraire assombrit toutes les couleurs superposées. Les blancs 
de l’image au premier plan s’assombrissent. En revanche, les blancs de l’image en 
arrière-plan inversent les valeurs de couleurs superposées de l’image au premier 
plan, créant ainsi un effet négatif.
À propos des exemples de cette section
La plupart des exemples de cette section sont créés à partir de deux images de réfé-
rence. L’image « Mondrian Singe » illustre les différentes interactions des valeurs de 
couleur de chaque image en fonction du mode de fusion sélectionné. En examinant 
les résultats, faites particulièrement attention aux zones blanches et noires des carrés 
de couleur ainsi qu’aux zones éclairées et sombres du singe. Vous pouvez ainsi vous 
rendre compte de la manière dont les blancs et les noirs d’une image sont traités par 
chaque mode de fusion.
Les autres couleurs plus claires et plus sombres servent à illustrer l’effet de chaque 
mode de fusion sur les valeurs de couleur intermédiaires superposées. Les carrés 
jaunes, gris, oranges et bleus, en particulier, ont tous des valeurs de couleur et de 
luminance très différentes contrastant nettement d’un exemple à l’autre.
Important : selon le mode de fusion choisi, l’ordre des couches et des groupes peut 
avoir son importance. Certains modes de fusion se comportent différemment selon 
l’image située au premier plan.
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Les noirs de l’image au premier plan s’éclaircissent, alors que les noirs de l’image 
en arrière-plan sont conservés.
Les valeurs de couleur intermédiaires superposées sont assombries en fonction de 
la couleur de l’image en arrière-plan. Dans les zones où l’arrière-plan est plus clair que 
le premier plan, l’image en arrière-plan est assombrie. Dans les zones où l’arrière-plan 
est plus sombre que le premier plan, les couleurs sont inversées.
Lorsque vous utilisez le mode de fusion Soustraire, l’ordre des deux objets est important.
Obscurcir
Le mode de fusion Obscurcir assombrit les zones les plus sombres de chaque image 
superposée. Les blancs sur n’importe quelle image rendent entièrement visible l’image 
superposée. Les valeurs de couleur intermédiaires plus claires deviennent de plus en 
plus translucides en faveur de l’image superposée. En revanche, les valeurs de couleur 
intermédiaires plus sombres en dessous de ce seuil restent unies, laissant moins passer 
les détails de l’image superposée. 
Lorsque vous utilisez le mode de fusion Obscurcir, vous pouvez placer les deux objets 
dans n’importe quel ordre.
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Astuces : le mode de fusion Obscurcir est pratique lorsque vous souhaitez utiliser 
une image comme texture d’une autre image, sélectionnée en fonction de ses zones 
les plus sombres. Vous pouvez apporter des variantes à cet effet en utilisant les modes 
de fusion Superposition, Densité couleur + et Densité linéaire +.
Multiplier
Comme avec le mode de fusion Obscurcir, le mode Multiplier assombrit les zones 
les plus sombres de chaque image superposée, la seule exception étant que les valeurs 
de couleur intermédiaires des deux images sont mélangées de manière plus uniforme. 
Les zones plus claires des images superposées deviennent progressivement de plus 
en plus translucides, rendant visible toute image plus sombre. Les blancs sur n’importe 
quelle image rendent entièrement visible l’image superposée. Les noirs des deux images 
sont conservés dans l’image obtenue.
Lorsque vous utilisez le mode de fusion Multiplier, vous pouvez placer les deux objets 
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Astuces : le mode de fusion Multiplier est particulièrement utile lorsque vous souhaitez 
éliminer les zones blanches d’une image au premier plan et fusionner le reste de cette 
image avec les couleurs en arrière-plan. Par exemple, si vous superposez le texte d’une 
feuille manuscrite numérisée sur une image en arrière-plan et que vous réglez le mode 
de fusion sur Multiplier, vous obtenez une image texturée avec les zones les plus sombres 
de l’image en arrière-plan.
Densité couleur +
Le mode de fusion Densité couleur + intensifie les zones sombres de chaque image. 
Les blancs de l’image en arrière-plan remplacent l’image au premier plan, alors que 
les blancs de l’image au premier plan deviennent transparents. Les valeurs de couleurs 
intermédiaires de l’image en arrière-plan rendent visibles celles de l’image au premier plan.
Les valeurs de couleur intermédiaires plus claires de l’image en arrière-plan rendent plus 
visibles l’image au premier plan. Les valeurs intermédiaires plus sombres de toutes les 
zones superposées visibles sont mélangées, ce qui a pour effet d’intensifier les couleurs.
Lorsque vous utilisez le mode de fusion Densité couleur +, l’ordre des deux objets 
est important.
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Densité linéaire +
Ce mode de fusion est semblable au mode Multiplier, la seule exception étant que 
les valeurs de couleur intermédiaires superposées plus sombres sont intensifiées, 
comme avec le mode de fusion Densité couleur +. Les valeurs de couleur plus claires 
des images superposées deviennent progressivement de plus en plus translucides, 
rendant visible toute image plus sombre. Les blancs sur n’importe quelle image 
rendent entièrement visible l’image superposée. 
L’ordre de deux objets auxquels on applique le mode de fusion Densité linéaire + 
importe peu.
Ajouter
Le mode de fusion Ajouter intensifie les blancs de chaque image superposée et éclaircit 
toutes les autres couleurs superposées. Les valeurs de couleur de tout pixel superposé 
sont additionnées. Les valeurs de couleur intermédiaires de l’image obtenue sont éclaircies. Les noirs de chaque image sont transparents, alors que les blancs sont conservés.
Lorsque vous utilisez le mode de fusion Ajouter, vous pouvez placer les deux objets 
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Astuces : le mode de fusion Ajouter est pratique lorsque vous souhaitez utiliser une 
image comme texture d’une autre image, sélectionnée en fonction de ses zones les 
plus claires, telles que les zones en surbrillance. Vous pouvez apporter des variantes à 
cet effet en utilisant les modes de fusion Éclaircir, Superposition, Densité couleur et 
Densité linéaire.
Éclaircir
Le mode de fusion éclaircit les zones les plus claires de chaque image superposée. Tous les 
pixels de chaque image sont comparés et le pixel le plus clair de chaque image est conservé. Les pixels les plus clairs de chaque image sont ensuite regroupés pour donner une 
image finale adoucie. Les blancs des deux images sont visibles dans l’image obtenue.
Lorsque vous utilisez le mode de fusion Éclaircir, vous pouvez placer les deux objets 
dans n’importe quel ordre.
Superposition
Comme avec le mode de fusion Éclaircir, le mode Superposition éclaircit les zones 
les plus claires de chaque image superposée, la seule exception étant que les valeurs 
de couleur intermédiaires des deux images sont mélangées de manière plus uniforme. 
Les noirs sur n’importe quelle image rendent entièrement visible l’image superposée. 
Les valeurs intermédiaires plus sombres en dessous d’un certain seuil rendent plus visible l’image superposée. Les blancs des deux images sont visibles dans l’image obtenue.332 Chapitre 3 Compositing standard
Lorsque vous utilisez le mode de fusion Superposition, vous pouvez placer les deux 
objets dans n’importe quel ordre.
Astuces : le mode de fusion Superposition est particulièrement pratique pour éliminer 
les zones noires situées derrière un sujet au premier plan, et mieux adapté que l’incrustation Luma Key. Cela est surtout utile lorsque vous souhaitez mélanger le reste 
du sujet au premier plan avec l’image en arrière-plan, en fonction de sa luminosité. 
Vous pouvez ainsi obtenir un effet d’éclat et d’éclairage, ainsi que simuler des reflets. 
Vous pouvez apporter des variantes à cet effet en utilisant les modes de fusion Ajouter, 
Éclaircir et Densité couleur -.
Densité couleur -
Les blancs situés sur l’image au premier plan ou en arrière-plan sont conservés dans 
l’image finale. Les noirs de l’image en arrière-plan remplacent l’image au premier plan, 
alors que les noirs de l’image au premier plan deviennent transparents.
Les valeurs de couleurs intermédiaires de l’image en arrière-plan rendent visibles celles 
de l’image au premier plan. Les valeurs de couleur plus sombres de l’image en arrière-plan 
rendent plus visibles l’image au premier plan. Toutes les valeurs de couleur intermédiaires 
superposées sont mélangées, ce qui permet d’obtenir des mélanges de couleurs 
intéressants.
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En inversant les deux images superposées, le mélange des valeurs de couleur intermé-
diaires superposées donne des résultats légèrement différents.
Densité linéaire -
Ce mode de fusion est semblable au mode Superposition, la seule exception étant que 
les valeurs de couleur intermédiaires plus claires des zones superposées sont intensifiées. 
Les noirs sur n’importe quelle image rendent entièrement visible l’image superposée. 
Les blancs des deux images sont visibles dans l’image obtenue.
L’ordre de deux objets auxquels on applique le mode de fusion Densité linéaire - 
importe peu.
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Incrustation
Les blancs et les noirs de l’image au premier plan deviennent translucides et interagissent 
avec les valeurs de couleur de l’image en arrière-plan, ce qui a pour effet d’intensifier 
le contraste. D’autre part, les blancs et les noirs de l’image en arrière-plan remplacent 
l’image au premier plan. 
Les valeurs intermédiaires superposées sont mélangées différemment selon la luminosité des valeurs de couleur d’arrière-plan. Les valeurs intermédiaires d’arrière-plan sont 
mélangées par effet de superposition. D’autre part, les valeurs intermédiaires sont 
mélangées par effet de multiplication.
Le résultat est le suivant : les valeurs de couleur noires de l’image en arrière-plan intensifient l’image au premier plan, alors que les valeurs de couleur plus claires de l’image 
en arrière-plan éclaircissent les zones superposées de l’image au premier plan.
Lorsque vous utilisez le mode de fusion Incrustation, l’ordre des deux objets est important.
Astuces : le mode de fusion Incrustation est particulièrement pratique pour fusionner 
des zones de couleurs vives dans deux images.
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Lumière tamisée
Le mode de fusion Lumière tamisée est semblable au mode Incrustation. Les blancs 
et les noirs de l’image au premier plan deviennent translucides mais interagissent avec 
les valeurs de couleur de l’image en arrière-plan. D’autre part, les blancs et les noirs de 
l’image en arrière-plan remplacent l’image au premier plan. Toutes les valeurs de couleurs 
intermédiaires superposées sont mélangées, ce qui a pour effet de renforcer les nuances 
par rapport au mode de fusion Incrustation.
L’ordre de deux objets utilisés avec le mode de fusion Lumière tamisée est important.
Astuces : le mode de fusion Lumière tamisée est pratique pour nuancer légèrement 
une image en arrière-plan, en la mélangeant avec les couleurs de l’image au premier plan.
Lumière crue
Les blancs et les noirs de l’image au premier plan ne laissent pas passer l’image en 
arrière-plan. D’autre part, les blancs et les noirs de l’image en arrière-plan interagissent 
avec les valeurs de couleur intermédiaires superposées de l’image au premier plan.
Les valeurs de couleur intermédiaires superposées sont mélangées différemment selon 
la luminosité des valeurs de couleur d’arrière-plan. Les valeurs intermédiaires d’arrière-plan 
sont mélangées par effet de superposition. D’autre part, les valeurs intermédiaires sont 
mélangées par effet de multiplication.
Le résultat est le suivant : les valeurs de couleur noires de l’image en arrière-plan intensifient l’image au premier plan, alors que les valeurs de couleur plus claires de l’image 
en arrière-plan éclaircissent les zones superposées de l’image au premier plan.
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L’ordre de deux objets utilisés avec le mode de fusion Lumière crue est important.
Lumière vive
Le mode de fusion Lumière vive est semblable au mode Lumière crue, à deux exceptions 
près : la première étant que les valeurs de couleur intermédiaires sont mélangées 
de manière plus intense et la seconde que les blancs et les noirs de chaque image 
superposée sont conservés dans l’image finale. 
Remarque : les zones blanches unies et noires unies superposées risquent d’être adoucies.
Les valeurs de couleur intermédiaires superposées sont mélangées différemment selon 
la luminosité des valeurs de couleur d’arrière-plan. Les valeurs intermédiaires plus claires 
deviennent transparentes, alors que le contraste des valeurs de couleur plus sombres 
est augmenté. L’effet global est plus prononcé que celui du mode de fusion Lumière crue.
En inversant les deux images superposées, le mélange des valeurs de couleur 
intermédiaires superposées donne des résultats légèrement différents.
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Lumière linéaire
Le mode de fusion Lumière linéaire est semblable au mode Lumière crue, la seule 
exception étant que les valeurs de couleur intermédiaires superposées sont mélangées 
avec plus de contraste. Les blancs et les noirs de l’image au premier plan ne laissent pas 
passer l’image en arrière-plan. D’autre part, les blancs et les noirs de l’image en arrière-plan 
interagissent avec les valeurs de couleur intermédiaires superposées de l’image 
au premier plan.
Les valeurs de couleur intermédiaires superposées sont mélangées. Les couleurs 
d’arrière-plan plus claires éclaircissent l’image au premier plan, alors que les couleurs 
plus sombres l’assombrissent.
L’ordre de deux objets utilisés avec le mode de fusion Lumière linéaire est important.
Lumière ponctuelle
Le mode de fusion Lumière ponctuelle est semblable au mode Lumière crue, la seule 
exception étant que les valeurs de couleur intermédiaires superposées sont mélangées 
différemment, en fonction de la valeur des couleurs. Les blancs et les noirs de l’image 
au premier plan ne laissent pas passer l’image en arrière-plan. D’autre part, les blancs 
et les noirs de l’image en arrière-plan interagissent avec les valeurs de couleur intermé-
diaires superposées de l’image au premier plan.
Les méthodes utilisées par le mode de fusion Lumière ponctuelle pour mélanger 
deux images sont un peu complexes. En effet, les segments de couleurs étant au nombre 
de quatre, les valeurs de couleur intermédiaires superposées sont traitées différemment 
selon le segment où elles se trouvent.
Â Les zones plus claires et plus sombres de l’image au premier plan près des couleurs 
blanches et noires sont conservées.
Â Les zones de l’image au premier plan situées près du centre des couleurs intermédiaires 
sont nuancées par la couleur d’arrière-plan. 
Â Les zones plus sombres de l’image au premier plan situées entre les noirs et le centre 
des couleurs intermédiaires sont éclaircies.
Â Les zones plus claires de l’image au premier plan situées entre les blancs et le centre 
des couleurs intermédiaires sont assombries.
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L’image finale risque d’être soit nuancée, soit solarisée, selon la luminosité ou l’obscurité 
des valeurs superposées. Ce mode de fusion permet également d’obtenir des effets 
plus abstraits.
L’ordre de deux objets utilisés avec le mode de fusion Lumière ponctuelle est important.
Mélange cru
Le mode de fusion Mélange cru est semblable au mode Lumière crue, la seule exception 
étant que la saturation des valeurs de couleurs intermédiaires superposées est intensifiée, 
ce qui a pour effet de produire des images avec un très fort contraste. Les blancs et 
les noirs sont conservés.
Même si l’ordre de deux objets n’a globalement aucun effet sur l’aspect des deux images 
fusionnées à l’aide du mode de fusion Mélange cru, il peut y a avoir de très légères 
différences.
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Différence
Ce mode de fusion est semblable au mode Soustraire, la seule exception étant que 
les zones de l’image qui seraient considérablement assombries par le mode de fusion 
Soustraire sont colorisées différemment.
Lorsque vous utilisez le mode de fusion Différence, vous pouvez placer les deux objets 
dans n’importe quel ordre.
Exclusion
Ce mode de fusion est semblable au mode Différence, la seule exception étant 
que l’image finale est globalement plus claire. Les zones superposées avec des valeurs 
de couleur plus claires sont éclaircies, alors que les valeurs de couleur superposées plus 
sombres deviennent transparentes.
Lorsque vous utilisez le mode de fusion Exclusion, vous pouvez placer les deux objets 
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Modes de fusion ayant un impact sur les canaux alpha
Les modes de fusion Stencil et Silhouette vous permettent d’utiliser le canal alpha ou 
les valeurs luma d’un seul objet pour isoler certaines régions des objets et des groupes 
d’arrière-plan.
Remarque : vous pouvez obtenir des effets identiques à l’aide de masques de forme 
et d’image. De plus, et en fonction de vos besoins, les masques vous donnent plus 
de contrôle. Pour plus d’informations, consultez la rubrique « Utilisation des formes 
et des masques » à la page 1071.
Les modes de fusion Stencil rognent toutes les parties non superposées des objets 
situés en dessous de l’objet utilisé comme pochoir. Les modes de fusion Silhouette 
ont l’effet contraire. En effet, ils font des trous dans les objets superposés inférieurs 
dont la forme est celle de l’objet utilisé comme silhouette.
Stencil alpha
Le mode de fusion Stencil alpha utilise le canal alpha de l’objet concerné pour éliminer 
toutes les parties non superposées des objets et des groupes répertoriés plus bas dans 
la liste de couches.
Stencil luma
Le mode de fusion Stencil luma fonctionne comme le mode Stencil alpha, mais il utilise 
la valeur luma de l’objet concerné pour définir la transparence. Le mode de fusion Stencil 
luma est pratique si l’objet que vous souhaitez utiliser pour le rognage n’a pas de canaux 
alpha propres.
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Silhouette alpha
Le mode de fusion Silhouette alpha a un effet opposé au mode Stencil alpha. Ce mode 
de fusion est utile si vous souhaitez découper des trous dans les objets inférieurs.
Silhouette luma
Le mode de fusion Silhouette luma a un effet opposé au mode Stencil luma.
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Limitation de l’effet des modes de fusion Stencil et Silhouette
Dès que vous recourez aux modes de fusion Stencil ou Silhouette sur un groupe dont 
le propre mode de fusion est réglé sur Au travers, l’effet obtenu est appliqué à chacun 
des objets de chaque groupe situé plus bas dans la liste de couches, sauf si le groupe 
qui le contient est tramé. Cette méthode est certes puissante, mais pas toujours 
intéressante au niveau de l’effet obtenu, car vous n’avez pas la possibilité de placer 
un groupe d’arrière-plan pour remplir la zone transparente.
Vous pouvez toutefois limiter l’effet des modes Stencil et Silhouette aux objets situés 
dans le même groupe, en réglant le mode de fusion de ce groupe sur tout autre 
mode que Au travers.
Si vous réglez sur Normal le mode de fusion du groupe englobant les deux objets 
de l’exemple Silhouette alpha, puis que vous ajoutez un groupe en dessous contenant 
d’autres objets, ces objets apparaissent au travers des zones transparentes créées 
par le groupe auquel est appliqué le mode Silhouette.342 Chapitre 3 Compositing standard
Derrière
Le mode de fusion Derrière permet de forcer l’affichage d’un objet derrière tous les autres 
objets et groupes, quelle que soit sa position dans l’onglet Couches et dans la Timeline.
Si vous appliquez le mode Derrière à plusieurs objets ou groupes, ils apparaissent 
derrière tous les groupes qui ne sont pas réglés sur le même mode, selon l’ordre 
dans lequel ils sont répertoriés dans l’onglet Couches.
Ajouter alpha
Le mode de fusion Ajouter alpha a un effet semblable à celui du mode Ajouter, mais 
au lieu d’ajouter les canaux de couleur des objets superposés, il ajoute l’ensemble 
de leurs canaux alpha. Utilisez ce mode de fusion à la place de la méthode par défaut 
de mixage de canal alpha de Motion pour obtenir un traitement différent des zones 
translucides.
Mélange prémultiplié
Le mode de fusion Mélange prémultiplié est destiné aux images de mixage prémultipliées, telles que les images générées par les logiciels de modélisation et de rendu 3D. 
(Les canaux rouge, vert et bleu d’une image prémultipliée sont multipliés par son canal 
alpha.) Le mode Mélange prémultiplié est utile pour les images avec des effets 
de lumière translucide, par exemple les reflets d’objectif, l’éclairage volumétrique, 
les effets de brouillard et de flou, etc.
Le mode de fusion Mélange prémultiplié exécute un montage composite non prémultiplié (l’image au premier plan est censée être déjà prémultipliée). Des imperfections 
peuvent apparaître du fait de pixels non prémultipliés dont les valeurs RVB et alpha 
sont très petites (vous obtenez des pixels avec des valeurs de 255). Dans certains cas, 
l’ordinateur exécute un filtrage bilinéaire et le mode de fusion dé-prémultiplie l’alpha.
Ombres portées
Par défaut, une ombre portée est une ombre translucide tombant derrière un objet, 
comme s’il était éclairé par l’avant. Les ombres portées ont les mêmes dimensions 
que l’objet d’où part l’ombre. Celle-ci peut être légèrement plus grosse lorsque vous 
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L’ombre portée donne l’illusion de profondeur, rendant plus réaliste aux yeux 
du spectateur l’objet situé au premier plan. C’est la raison pour laquelle les ombres 
portées sont fréquemment utilisées pour donner une impression d’espace entre 
des objets superposés.
Les ombres portées ont aussi pour effet d’assombrir les régions superposées des objets 
en arrière-plan. Un exemple pertinent d’utilisation des ombres portées est lorsque 
vous placez du texte sur un fond pouvant l’assombrir. En ajoutant une ombre portée, 
vous pouvez rendre l’objet texte au premier plan plus facile à lire.
Il est très simple d’ajouter une ombre portée à un objet quelconque, car l’Inspecteur 
et la palette proposent des paramètres Ombre portée pour chaque objet. Une fois activé, 
vous pouvez modifier les ombres portées directement dans le Canevas.
Important : les objets texte disposent de paramètres d’ombres portée supplémentaires, 
dans la fenêtre Style de l’onglet Texte. Pour en savoir plus sur les ombres portées utilisées 
sur des objets textes, voir « Ajout d’une ombre portée » à la page 673.
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Ajustement des ombres portées dans le Canevas
La palette et les commandes à l’écran vous offrent une méthode interactive pour 
modifier l’ombre portée d’un objet.
Commandes Ombre portée disponibles dans la palette
Sitôt que vous sélectionnez un objet dans le Canevas, la palette affiche trois paramètres 
Ombre portée :
Ombre portée : case servant à activer ou désactiver l’ombre portée de n’importe 
quel objet.
Opacité : définit la transparence de l’ombre portée.
Flou : ajuste le flou de l’ombre portée.
Remarque : si vous sélectionnez un objet texte, la palette n’affiche aucun de 
ces paramètres.
Outil de transformation Ajuster l’ombre portée
La sélection de l’outil de transformation Ajuster l’ombre portée dans la barre d’outils 
vous permet d’accéder à des commandes à l’écran supplémentaires pour les objets 
sélectionnés dont l’ombre portée est activée.
Les quatre poignées d’angle servent à augmenter ou diminuer le flou de l’ombre portée. 
Pour modifier l’angle et les dimensions de l’ombre portée, faites-la glisser à l’intérieur 
du cadre de sélection de l’ombre portée.
Poignées de flou 
de l’ombre portée
Position de l’ombre portée 
à l’intérieur du cadre de 
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Pour augmenter ou réduire le flou d’une ombre portée :
1 Cliquez sur l’outil Sélectionner/Transformer tout en maintenant le bouton de la souris 
enfoncé, puis choisissez l’outil Ajuster l’ombre portée dans le menu local.
2 Dans le Canevas, faites glisser l’une des quatre poignées d’angle vers l’intérieur 
pour réduire le flou d’une ombre portée ou vers l’extérieur pour l’augmenter.
Pour déplacer l’ombre portée d’un objet :
1 Cliquez sur l’outil Sélectionner/Transformer tout en maintenant le bouton de la souris 
enfoncé, puis choisissez l’outil Ajuster l’ombre portée dans le menu local.
2 Placez le pointeur n’importe où dans le cadre de sélection de l’ombre portée, 
puis faites-le glisser dans la direction souhaitée.
Paramètres Ombre portée disponibles dans l’onglet Propriétés
Outre les commandes disponibles dans le Canevas et la palette, chaque objet dispose 
de ses propres paramètres Ombre portée dans l’onglet Propriétés.
Utilisez la case pour activer ou désactiver l’ombre portée de n’importe quel objet.
Couleur : définit la couleur de l’ombre portée (noir par défaut).
Opacité : définit la transparence de l’ombre portée.
Flou : spécifie le flou de l’ombre portée.
Distance : définit la distance entre l’ombre portée et l’objet. Plus l’ombre portée est 
loin, plus la distance entre l’objet et tout ce qui se trouve derrière dans la composition 
semble importante.
Angle : modifie la direction de l’ombre portée. La modification de l’angle de l’ombre 
portée a pour effet de modifier la direction de la lumière à l’origine de l’ombre.
Resynchronisation
Dans vos projets d’animation graphique, vous serez sans doute amené à mettre en 
œuvre certaines astuces pour contrôler le temps dans vos médias : accélérer un plan, 
le ralentir ou le lire à diverses vitesses.
Utilisation des comportements Resynchronisation
Cette catégorie de comportements vous offre diverses méthodes pour exécuter 
rapidement les tâches de resynchronisation les plus courantes. Il vous suffit alors 
de quelques instants pour réaliser une image arrêtée ou stroboscopique à l’aide 
d’un comportement Resynchronisation. Prenez donc tout votre temps pour étudier 
les comportements de la catégorie Resynchronisation, avant de perdre des heures 
à créer vos propres comportements personnalisés de resynchronisation via l’Inspecteur. Pour en savoir plus sur les comportements Resynchronisation, voir 
« Comportements Resynchronisation » à la page 495.346 Chapitre 3 Compositing standard
Commandes Contrôle du temps dans l’Inspecteur
Chaque objet de média dispose de ses propres paramètres de contrôle du temps 
dans l’onglet Propriétés :
Time Remap : détermine le mode de défilement du temps dans le plan. Utilisez ce menu 
local pour choisir Vitesse constante ou Vitesse variable. La valeur Vitesse constante 
resynchronise l’intégralité du plan en utilisant la même valeur, alors que Vitesse variable 
vous permet d’animer la vitesse du plan au fil du temps.
Vitesse : détermine la vitesse du plan sous forme de pourcentage. La valeur par défaut 
est égale à 100 %. Les valeurs inférieures à 100 lisent le plan plus lentement que sa vitesse 
d’origine, augmentant ainsi sa durée. Quant aux valeurs supérieures à 100, elles provoquent 
la lecture du plan plus rapidement que sa vitesse d’origine, diminuant ainsi sa durée. 
Ce paramètre n’est affiché que si Time Remap est réglé sur Vitesse constante.
Valeur de resynchronisation : affiche la valeur temporelle du plan sur une image donnée. 
Ce paramètre n’est affiché que si Time Remap est réglé sur Vitesse variable. Dans ce cas, 
deux images clés sont automatiquement générées au niveau de la première et de 
la dernière images du plan. Ces deux images clés représentent une vitesse constante 
de 100 %. Si vous ajoutez des images clés à ce paramètre et leur affectez d’autres 
valeurs de resynchronisation, la vitesse du plan passe d’une vitesse à la suivante.
Entrée : détermine le point d’entrée de l’objet, aussi bien en vitesse constante que 
variable. Le réglage de ce paramètre déplace toujours le point d’entrée de l’objet vers 
l’image indiquée, sans pour autant affecter sa durée.
Sortie : détermine le point de sortie de l’objet, aussi bien en vitesse constante que 
variable. Le réglage de ce paramètre déplace toujours le point de sortie de l’objet vers 
l’image indiquée, sans pour autant affecter sa durée.
Durée : détermine la durée totale de l’objet. Si Time Remap est réglé sur Vitesse constante, 
le réglage de la Durée affecte également la Vitesse et le Point de sortie. En revanche, 
si Time Remap est réglé sur Vitesse variable, le réglage de la Durée n’affecte en rien 
la lecture à vitesse variable.
Inverser : cette case permet d’activer/désactiver la lecture à l’envers du plan.
Fusion d’images : détermine la méthode utilisée pour fusionner l’image au cours 
de chaque image lue. Le menu local Fusion d’images propose les options suivantes :
Â Aucune : affiche l’image du plan d’origine au plus près de l’image source.
Â Fusion : option par défaut. Affiche une fusion des pixels individuels d’images adjacentes.
Â Fusion flou d’animation : applique un algorithme de flou d’animation aux images 
fusionnées.
Â Flux optique : utilise un algorithme de flux optique pour fusionner les deux images 
entourant l’image souhaitée. L’activation de cette méthode affecte les performances 
de lecture de manière considérable. Pour afficher les images correctement, Motion 
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Si vous sélectionnez Flux optique, un indicateur d’analyse apparaît à gauche des 
commandes de lecture situées sous le Canevas, afin de vous indiquer que le plan 
est en cours d’analyse. 
Si vous lancez la lecture du projet avant la fin de l’analyse, le plan apparaît comme si 
l’option Fusion d’images était réglée sur Aucune. Une fois l’analyse terminée, l’indicateur 
disparaît et le plan est lu correctement. Si vous le souhaitez, vous pouvez consulter des 
informations détaillées sur l’analyse du plan et l’arrêter avant qu’elle ne soit terminée.
Important : lors de l’importation d’une séquence entrelacée et de l’utilisation de la 
méthode Flux optique pour la fusion d’images, des imperfections risquent d’apparaître 
au sein de l’objet resynchronisé si le paramètre Priorité de trame n’est pas réglé sur 
une valeur adaptée.
Pour afficher plus d’informations sur l’analyse en cours d’un plan, procédez de 
l’une des manières suivante :
m Au cours de l’analyse du plan, cliquez sur l’indicateur d’analyse.
m Choisissez Fenêtre > Afficher la liste des tâches.
La liste des tâches d’arrière-plan apparaît alors.
La liste des tâches d’arrière-plan répertorie tous les processus que Motion est en train 
d’exécuter à l’arrière-plan. Chaque tâche est référencée par un libellé, une barre de progression et un texte indiquant le temps restant avant la fin de la tâche. Vous pouvez 
annuler une tâche en cours ou en suspens en cliquant sur le bouton Arrêter situé 
à côté de sa barre de progression.
Condition de fin : menu local vous permettant de déterminer la suite de la lecture 
lorsque la fin du plan est atteinte. Il existe quatre options :
Â Aucune : option par défaut. La durée du plan dans votre projet est égale à la durée 
du fichier de média source correspondant.
Indicateur d’analyse
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Â En boucle : lorsque la dernière image du plan est atteinte, le plan revient en boucle 
sur la première image et reprend la lecture. Cela peut provoquer un saut dans 
la lecture du plan, à moins que ce dernier n’ait été désigné pour être mis en boucle 
de manière transparente.
Â Ping-Pong : lorsque la dernière image du plan est atteinte, la lecture suivante du 
plan est effectuée en sens inverse. Si vous choisissez l’option Ping-Pong pour un plan 
montrant une balle roulant au sol, vous verrez la balle rouler en avant, puis en arrière 
et ainsi de suite pendant toute la durée de l’objet. Cette option permet d’étendre 
la durée de certains plans vidéo de manière plus fluide qu’avec l’option En boucle.
Â Suspendre : la dernière image du plan est figée pendant le temps indiqué grâce 
au curseur Durée de fin.
Remarque : si vous activez l’option Suspendre avec une séquence entrelacée, 
assurez-vous que le paramètre Ordre de trame est correctement défini dans l’onglet 
Média de l’Inspecteur. Pour modifier ce paramètre, sélectionnez le plan dans l’onglet 
Média de la sous-fenêtre Projet, puis choisissez une option dans le menu local Ordre 
de trame de l’onglet Média de l’Inspecteur.
Durée de fin : curseur vous permettant de fixer le nombre d’images à ajouter au plan 
à la fin de sa durée. Cette valeur peut être définie uniquement si Condition de fin est 
réglée sur toute autre valeur que Aucune.
Exportation d’une sélection
Une fois que vous avez ajusté les éléments d’un projet pour qu’ils correspondent exactement à vos souhaits, vous pouvez avoir envie de les réutiliser dans un autre projet. 
Pour ce faire, exportez ces éléments sous forme de fichiers rendus, afin de minimiser 
leur impact sur les performances de lecture d’un projet complexe. Ce processus 
s’appelle la transformation.
Pour transformer les éléments sélectionnés en vue de leur exportation :
1 Sélectionnez les couches de votre projet que vous souhaitez transformer.
2 Choisissez Fichier > Exporter la sélection.
Resynchronisation dans la Timeline
Vous pouvez également manipuler le contrôle du temps d’un plan dans la Timeline 
grâce aux touches de modification. Les indicateurs affichés par la Timeline vous 
aident à visualiser les boucles et toutes les autres conditions de resynchronisation. 
Pour en savoir plus sur la resynchronisation dans la Timeline, voir « Resynchronisation 
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3 Sélectionnez les options de votre choix dans la zone de dialogue Exporter la sélection, 
puis cliquez sur Exporter.
Options de la zone de dialogue Exporter la sélection
Cette zone de dialogue contient des options qui vous permettent d’attribuer un nom 
au fichier, de définir quel type de fichier vous souhaitez créer, d’indiquer quels éléments 
inclure à l’exportation, ainsi que des options concernant les événements survenant 
une fois l’exportation terminée. Elle vous propose les options suivantes :
Enregistrer sous : attribuez un nom au fichier que vous souhaitez exporter.
Emplacement : choisissez un emplacement d’enregistrement pour le fichier exporté.
Exporter : choisissez un type de fichier dans ce menu local. Cliquez sur le bouton 
Options pour définir des options de sortie. Pour en savoir plus sur les options d’exportation, voir le chapitre 14, « Exportation de projets Motion », à la page 1235.
Le menu local Exporter vous propose les options suivantes :
Â Séquence QuickTime : si cette option est sélectionnée, une séquence QuickTime 
est créée.
Â Séquence d’images : si cette option est sélectionnée, une série de fichiers d’image 
numérotés est exportée. Chaque fichier contient une seule image de la séquence.
Â Sur l’image actuelle : si cette option est sélectionnée, seule l’image sur laquelle la 
tête de lecture est positionnée est exportée.
Utiliser : menu local vous permettant de choisir des préréglages d’exportation. Pour 
en savoir plus sur les options d’exportation, voir le chapitre 14, « Exportation de projets 
Motion », à la page 1235. Selon l’option que vous avez choisie dans le menu local 
Exporter, l’un des trois préréglages par défaut apparaît dans le menu local Utiliser :
Â Séquence - Utiliser les réglages actuels du projet et du Canevas : activée par 
défaut si vous avez choisi Séquence QuickTime dans le menu local Exporter, cette 
option utilise les réglages actuels du projet et du Canevas lors du rendu de la sélection pour son exportation.Â Séquence d’images - Utiliser les réglages actuels du projet et du Canevas : activée 
par défaut si vous avez choisi Séquence d’images dans le menu local Exporter, cette 
option utilise les réglages actuels du projet et du Canevas lors du rendu de la sélection 
pour son exportation.
Â Image - Utiliser les réglages actuels du projet et du Canevas : activée par défaut si vous 
avez choisi Sur l’image actuelle dans le menu local Exporter, cette option utilise les réglages actuels du projet et du Canevas lors du rendu de la sélection pour son exportation.
Inclure : menu local qui vous permet de déterminer quels éléments audio et vidéo 
inclure à l’exportation. Il existe trois options :
Â Vidéo et audio : cette option exporte tous les éléments vidéo et audio.
Â Vidéo seulement : cette option exporte uniquement les éléments vidéo.
Â Audio seulement : cette option exporte uniquement les éléments audio.
Après exporté : menu local vous permettant de définir les opérations à accomplir 
sur le fichier obtenu à l’issue de l’exportation. Il existe quatre options :
Â Ne rien faire : si cette option est sélectionnée, aucune opération n’est exécutée 
à la fin de l’exportation.
Â Ouvrir dans la fenêtre du visualiseur : option par défaut qui ouvre l’élément 
exporté dans le visualiseur.
Â Ajouter aux données : cette option ajoute l’élément exporté dans l’onglet Média 
du projet en cours.
Remarque : l’élément exporté n’apparaît pas dans le Canevas.
Â Importer dans le projet : cette option importe l’élément dans le projet à l’issue 
de exportation. Par défaut, la séquence est importée dans le Canevas et elle apparaît 
dans la hiérarchie de la liste de couches juste au-dessus des éléments utilisés pour 
la créer.
Commandes Exposer
Les principales commandes d’exposition disponibles dans Motion vous permettent de 
consulter plusieurs fenêtres simultanément, en les développant et en les redimensionnant sans avoir à les déplacer manuellement.
Ces commandes vous permettent d’accéder rapidement à l’écran à toutes les couches 
d’un projet directement dans le Canevas, ainsi que de sélectionner des éléments sans avoir 
à naviguer dans la liste de couches ou dans la Timeline. Elles vous permettent également de 
sélectionner des couches qui ne sont pas activées à la position actuelle de la tête de lecture 
et d’accéder automatiquement au point d’entrée d’une couche sélectionnée.
Il existe deux commandes d’exposition : la première affiche toutes les couches 
d’un projet, alors que la seconde affiche uniquement les couches activées à la position 
actuelle de la tête de lecture dans la Timeline.Chapitre 3 Compositing standard 351
Exposition de toutes les couches
Grâce à la commande Exposer toutes les couches, vous pouvez vous faire une idée 
de tous les éléments contenus dans votre projet et sélectionner rapidement l’élément 
que vous souhaitez manipuler. 
Pour exposer toutes les couches de votre projet :
1 Cliquez n’importe où dans le Canevas.
2 Appuyez sur les touches Maj + X.
Toutes les couches du projet sont temporairement réduites et étalées sur le Canevas. 
Chacune est représentée par une image blanche dans le Canevas. Positionnez le pointeur au-dessus d’une image pour afficher le nom de la couche correspondante.
3 Sélectionnez la couche sur laquelle vous souhaitez travailler.
Les couches reprennent leur taille et leur position d’origine. L’élément est sélectionné 
dans le Canevas et la tête de lecture se déplace sur la première image de la couche 
sélectionnée.
Exposition des couchesactivées
Grâce à la commande Exposer les couches activées, vous pouvez afficher toutes 
les couches activées à la position de la tête de lecture dans la Timeline.
Pour exposer tous les objets activés à la position de la tête de lecture :
1 Cliquez n’importe où dans le Canevas.
2 Appuyez sur la touche X.
Toutes les couches activées à la position actuelle de la tête de lecture sont temporairement 
réduites et étalées sur le Canevas. Chacune est représentée par une image blanche dans 
le Canevas. Positionnez le pointeur au-dessus d’une image pour afficher le nom de 
la couche correspondante.
3 Sélectionnez l’objet sur lequel vous souhaitez travailler.
Les éléments reprennent leur taille et leur position d’origine. L’élément est sélectionné dans 
le Canevas et la tête de lecture se déplace sur la première image de l’objet sélectionné.
Canevas après l’activation de la commande 
Exposer toutes les couches
Canevas avant l’activation de la commande 
Exposer toutes les couches352 Chapitre 3 Compositing standard
Exposition des zones de dépôt
Les modèles Motion contiennent souvent des zones de dépôt sur lesquelles vous pouvez 
glisser et déposer vos propres objets image. Par ailleurs, vous pouvez créer vos propres 
zones de dépôts dans n’importe lequel de vos projets. Utilisez la fonction d’exposition 
de Motion lorsque vous faites glisser des éléments du Navigateur ou de la Bibliothèque 
vers le Canevas pour voir apparaître automatiquement une présentation développée 
de toutes les zones de dépôt valides au sein du projet.
Pour exposer toutes les zones de dépôt d’un projet:
1 Dans la Bibliothèque ou le Navigateur, localisez l’objet que vous souhaitez importer 
dans le projet.
2 Maintenez enfoncée la touche Commande et faites glisser cet objet vers le Canevas.
L’objet que vous faites glisser sur le Canevas est affiché sous la forme d’une vignette. 
Votre pointeur prend la forme d’une flèche courbe jusqu’à ce que vous déposiez l’objet. 
Tous les objets activés sont développés et redimensionnés dans le Canevas afin que vous 
puissiez tous les voir en même temps. Positionnez le pointeur au-dessus d’un objet pour 
afficher son nom dans la liste de couches.
3 Faites glisser l’objet sur sa cible.
L’objet prend la place de sa cible. Les éléments reprennent leur taille et leur position 
d’origine et la tête de lecture se déplace sur la première image de l’objet déposé.
Exposition des zones de dépôt4
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4 Utilisation de la Timeline
Disposez et modifiez aisément et de manière flexible 
les ressources de votre projet dans la Timeline. Visualisez 
vos objets répartis sur les couches et les pistes.
La Timeline affiche tous les objets de votre projet et vous fournit une représentation 
graphique de l’organisation de votre projet au fil du temps. Vous pouvez disposer vos 
objets afin qu’ils commencent et finissent sur les images de votre choix. Vous pouvez 
également aligner plusieurs effets afin qu’ils surviennent simultanément. Vous pouvez 
contrôler les durées des objets et même effectuer des opérations de Trim courantes 
pour modifier les objets comme vous le feriez dans un programme de montage vidéo.
Des contrôles supplémentaires vous permettent de manipulez les masques, les filtres, 
les comportements, les images clés et les éléments audio, ainsi que vos séquences 
visuelles. La réglette de la Timeline fournit une référence exacte pour la gestion du temps 
et la synchronisation des effets. Vous pouvez verrouiller les pistes afin d’en prévenir toute 
modification, masquer temporairement un objet et gérer les liens entre les données 
audio et vidéo.
Réglette 
de la 
Timeline
Zone de 
pistes
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Bien que vous puissiez effectuer de nombreux types d’effets sans jamais utiliser la Timeline, 
il s’agit d’un outil essentiel pour manipuler la durée des éléments qui constituent votre 
projet. Motion intègre de nombreuses fonctions généralement réservées aux logiciels 
de montage non linéaire utilisés dans un flux de travaux de compositing.
Par défaut, la Timeline n’est pas affichée dans la présentation standard. Il est possible 
de la visualiser en affichant la fenêtre Contrôle du temps. 
Pour afficher la fenêtre Contrôle du temps, procédez de l’une des manières suivantes :
m Cliquez sur l’icône Contrôle du temps (dans l’angle supérieur droit de la barre d’outils).
m Faites glisser vers le haut le séparateur sous le bouton Lecture dans les commandes 
de lecture.
m Choisissez Fenêtre > Présentations > Cinéma.
m Appuyez sur la touche F6.
La présentation Cinéma déplace l’Inspecteur à droite de l’interface et affiche 
la sous-fenêtre Contrôle du temps.
Remarque : pour modifier la présentation de l’interface, choisissez Fenêtre > Présentations, puis sélectionnez la présentation Standard, Alternative ou Cinéma. Vous pouvez 
également créer et enregistrer vos modes de présentation. Voir « Présentation des 
fenêtres » à la page 25 pour en savoir plus sur les présentations.
Si la fenêtre Contrôle du temps est ouverte, il se peut que vous deviez cliquer 
sur l’onglet Timeline pour l’amener au premier plan. 
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Familiarisation avec la Timeline
La Timeline est constituée de deux parties : la liste de couches à gauche et la zone 
réservée aux pistes à droite. Chaque objet de votre projet apparaît sous la forme d’une 
barre colorée, sur sa propre piste horizontale, arrangé selon une hiérarchie identique à 
celle de la liste de couches dans la fenêtre Projet. Cela vous permet de voir rapidement 
chaque emplacement de l’objet dans le temps ainsi que sa position relative et sa durée.
Vous pouvez déterminer le type de chaque objet en fonction de son apparence dans 
la liste de couches de la Timeline.
Si vous sélectionnez un objet, la couleur prend un ton plus foncé et le nom de l’objet 
s’affiche en blanc. Lorsque la Timeline est en mode Pellicule, les images de la pellicule 
sont mises en surbrillance et entourées d’un cadre blanc. Voir « Spécification de 
l’affichage des pistes » à la page 362 pour en savoir plus sur les différents modes d’affichage de la Timeline.
Élément Apparence Description
Groupe Double barre bleue. La barre inférieure 
affiche trois lignes et le nombre 
d’objets contenus dans le groupe.
Couches 
(vidéo, images, formes, texte, 
particules, réplicateurs)
Barre bleue 
Masques Barre grise
Comportements et filtres Barre violette étroite
Caméra Barre bleue
Lumière Barre bleue
Images clés Losanges bleus affichés dans une barre 
étroite située sous l’objet animé 
par ces images clés. Les images clés 
sélectionnées apparaissent en blanc.
Audio Barre verte affichant la forme du signal 
audio. Si un comportement Audio 
est appliqué au fichier audio, la barre 
violette apparaît sous la piste audio.356 Chapitre 4 Utilisation de la Timeline
Liste de couches de la Timeline
La liste de couches de la Timeline est le reflet de l’onglet Couches de la sous-fenêtre 
du projet. Elle affiche tous les objets de votre projet (groupes, couches, filtres, comportements, etc.) et leur ordre dans la pile. Elle permet également de visualiser les comportements, filtres, masques et images clés appliqués à un objet. Vous pouvez d’ailleurs 
y réorganiser les objets. Cette modification est immédiatement reflétée dans la liste 
de couches de la fenêtre Projet. Vous pouvez également verrouiller les pistes afin d’en 
empêcher toute modification ultérieure et désactiver des pistes entières pour qu’elles 
ne soient pas affichées dans le Canevas.
Noms d’objets
Il est possible de renommer n’importe quel objet dans Motion, ce qui peut s’avérer 
utile si vous utilisez plusieurs versions d’une même ressource ou plusieurs caméras, 
voire si vous souhaitez classer vos éléments dans des groupes identifiés par des noms. 
Les masques, formes, particules et autres contenus générés à l’aide de Motion sont 
créés avec des noms génériques. En les renommant, vous serez à même de mieux 
les gérer et d’en effectuer le suivi pendant votre travail.
Pour renommer un objet :
1 Dans la liste de couches de la Timeline, double-cliquez sur le nom de l’objet.
2 Tapez un nouveau nom dans le champ de texte.
3 Appuyez sur la touche Retour ou Tabulation.
Bien que Motion vous permette de renommer les objets que vous importez depuis 
votre disque, la modification du nom de l’objet dans la liste de couches de la Timeline 
ne modifie pas le nom du fichier sur le disque. Cela vous permet d’utiliser plusieurs 
fois un plan source et d’attribuer à chaque instance un nom unique dans Motion.Chapitre 4 Utilisation de la Timeline 357
Activation des pistes de la Timeline
Chaque piste de la liste de couches de la Timeline dispose à sa gauche d’une case 
d’activation qui permet de l’activer et de la désactiver. Toute piste désactivée est ignorée 
dans le Canevas. Vous pouvez donc activer et désactiver des objets vidéo et audio, 
mais également des effets tels que les masques, les filtres et les comportements.
Pour activer ou désactiver la visibilité d’un objet :
m Cochez la case située sur le bord gauche de la piste que vous souhaitez contrôler.
Lorsque la case est cochée, la visibilité est activée et lorsque la case est décochée, 
la visibilité est désactivée. De plus, lorsqu’une piste est désactivée, la totalité de la piste 
apparaît estompée dans la Timeline.
Gestion de la liste de couches de la Timeline
Motion vous permet de réduire et de développer différentes parties de la liste de couches 
de la Timeline pour afficher plus ou moins de données, selon les besoins de votre travail. 
Vous avez la possibilité de réduire les couches auxquelles sont appliqués des masques, 
des filtres ou d’autres objets, afin de masquer les barres relatives aux effets. De même, 
vous pouvez réduire des groupes entiers pour masquer tous les objets qu’ils contiennent.
Lorsqu’une couche ou un groupe est réduit de cette manière, il apparaît toujours dans 
la fenêtre du Canevas. Contrairement à l’activation ou à la désactivation des pistes, la 
réduction et le développement de la liste de couches de la Timeline n’est qu’un outil 
d’organisation qui vous aide à gérer l’affichage de la Timeline. 
La case Activation n’est
pas cochée.
Piste désactivée
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Pour réduire ou développer une couche ou un groupe dans la Timeline :
m Cliquez sur le triangle d’affichage situé à gauche du nom de la couche ou du groupe. 
Si aucun triangle d’affichage n’est présent, cela signifie que cet objet ne peut être 
réduit ou développé davantage.
Ajout et suppression de groupes
Motion vous autorise à ajouter et supprimer des groupes directement dans la liste 
de couches de la Timeline. Si vous n’avez sélectionné aucun objet avant d’ajouter 
un nouveau groupe, ce groupe apparaît tout en haut de la liste. Dans le cas contraire, 
le nouveau groupe est ajouté juste au-dessus de l’objet sélectionné.
Pour ajouter un groupe :
m Cliquez sur le bouton Ajouter (+).
Vous pouvez également ajouter un groupe en faisant glisser un nouvel élément 
dans votre projet.
Pour supprimer un groupe :
1 Sélectionnez le groupe à supprimer.
2 Cliquez sur le bouton Supprimer (-).
Le bouton Supprimer sert également à supprimer tout objet (caméra, couche, groupe, 
filtre, etc.) de la liste de couches de la Timeline. Vous pouvez aussi cliquer sur une couche 
tout en maintenant la touche Contrôle enfoncée, puis choisir Supprimer dans le menu 
contextuel.
Verrouillage de pistes
Il peut arriver que vous souhaitiez empêcher toute modification d’un élément particulier. 
L’icône de verrouillage située sur le côté droit de la liste de couches de la Timeline vous 
permet de verrouiller un objet et d’empêcher toute modification de cet objet. Tout objet 
verrouillé dans la Timeline apparaît également verrouillé dans la liste de couches de 
la fenêtre Projet. 
Bouton Ajouter
Icône de verrouillage
Pistes verrouillées dans 
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Lorsque vous verrouillez un objet, son cadre de sélection dans le Canevas passe 
du blanc au rouge et la barre de couleur qui le représente est hachurée.
Les pistes verrouillées apparaissent toujours dans le Canevas et sont incluses dans votre 
résultat final. Bien que vous ne puissiez pas modifier un objet verrouillé, vous pouvez 
toujours copier ou dupliquer cet objet ou modifier l’ordre des couches de cet objet. 
Pour verrouiller une piste :
m Cliquez sur l’icône de verrouillage située sur le bord droit de la liste de couches 
de la Timeline.
Liens audio/vidéo
Les objets contenant des données audio et vidéo sont généralement liés afin 
de demeurer synchronisés. Ce lien est représenté par une icône dans la liste 
de couches de la Timeline.
Remarque : pour afficher les éléments audio dans la Timeline, cliquez sur le bouton 
Afficher l’audio.
Les objets liés sont toujours montés ensemble dans la Timeline. Les opérations telles 
que couper, copier, coller et scinder ont également une incidence à la fois sur les éléments 
audio et sur les éléments vidéo. Toutefois, si vous souhaitez casser ce lien afin de pouvoir 
déplacer ou monter séparément les éléments audio et vidéo, vous pouvez désactiver 
ce lien et déplacer librement chacun de ces objets. Sachez toutefois que cette opération 
risque de désynchroniser la lecture audio et vidéo.
Pour manipuler séparément des éléments audio et vidéo :
1 Cliquez sur l’icône du lien à droite du nom de l’objet pour l’élément vidéo ou audio.
L’icône du lien se transforme alors pour représenter un lien brisé.360 Chapitre 4 Utilisation de la Timeline
2 Déplacez, appliquez un Trim ou faites glisser la barre audio ou vidéo.
L’icône Lier apparaît également dans la liste Couches de la sous-fenêtre Projet.
Options de présentation de la Timeline
L’angle inférieur gauche de la Timeline contient plusieurs contrôles permettant 
de personnaliser les éléments qui apparaissent dans la Timeline. 
Les pistes audio sont affichées dans une partition séparée de la Timeline. Vous pouvez 
redimensionner les partitions en faisant glisser leur ligne de séparation.
Avant Après
Bouton Nom du bouton Fonction
Afficher/Masquer 
les couches
Affiche l’ensemble des groupes, couches et objets. 
Pour que ce bouton ait le moindre effet, les pistes audio 
doivent être affichées.
Afficher/Masquer 
l’audio
Affiche les pistes audio. Les formes d’onde apparaissent 
sur les pistes audio. Si un comportement Audio est 
appliqué au fichier audio, la barre violette apparaît sous 
la piste audio.
Remarque : si un comportement Audio est appliqué 
à un fichier audio affiché dans la Timeline, ce comportement apparaît en dessous de la piste audio qu’il modifie.
Afficher/Masquer 
les images clés
Affiche les images clés de toutes les pistes. Les images 
clés apparaissent sous la forme de losanges bleus 
(blancs lorsqu’ils sont sélectionnés).
Afficher/Masquer 
les masques
Affiche les pistes de masque pour les objets sur lesquels 
des masques sont appliqués.
Afficher/Masquer 
les comportements
Affiche les pistes de comportement pour les objets 
sur lesquels des comportements sont appliqués.
Afficher/Masquer 
les filtres
Affiche les pistes de filtre pour les objets sur lesquels des 
filtres sont appliqués.
Définir la hauteur 
de ligne de 
la Timeline
Cliquez sur l’un des boutons « Définir la hauteur de ligne 
de la Timeline » afin de sélectionner une taille de piste. 
Pour redimensionner des pistes manuellement, positionnez le pointeur sur une ligne de séparation, puis faites-la 
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Zoom dans la Timeline
Vous pouvez effectuer des zooms avant et arrière dans la Timeline à l’aide de la commande Zoom/Défilement ou du curseur de zoom. Ces commandes vous permettent 
toutes deux d’effectuer des zooms avant et arrière horizontalement dans la Timeline, en 
affichant une durée plus ou moins grande dans la fenêtre de la Timeline. Le zoom avant 
vous permet de voir plus de détails et, par conséquent, de placer vos objets de manière 
plus précise. L’utilisation du curseur de zoom maintient la Timeline centrée sur votre 
image actuelle. 
La commande Zoom/Défilement apparaît au bas de la fenêtre de la Timeline et vous 
permet de faire défiler votre projet en faisant glisser la case de défilement vers la gauche 
ou la droite. Elle permet également de faire un zoom avant ou arrière sur votre Timeline. 
Elle peut vous aider à naviguer plus rapidement à travers votre projet car elle fournit 
une vue d’ensemble instantanée de votre Timeline. La largeur de cette commande 
représente la durée totale de votre projet, alors que la largeur de la case de défilement 
identifie le segment visualisé. 
Si vous faites glisser l’une des poignées de la case de défilement vers l’intérieur, la case 
devient plus courte et initie un zoom avant sur la Timeline. Au contraire, lors du glissement 
de l’une des poignées vers l’extérieur, la case devient plus longue et elle exécute un zoom 
arrière sur la Timeline. La tête de lecture de la Timeline est toujours visible, ce qui permet 
de fournir un point de référence pour le segment de votre Timeline visualisé.
Pour effectuer un zoom avant ou arrière sur votre Timeline :
m Faites glisser la poignée vers l’une des extrémités de la case de défilement. Faites glisser 
vers le centre de la Timeline pour effectuer un zoom avant. Faites-la glisser vers l’extérieur 
pour effectuer un zoom arrière.
Si vous appuyez sur la touche Maj tout en faisant glisser la poignée, l’extrémité opposée 
reste en place, vous permettant ainsi d’effectuer un zoom avant ou arrière du côté de 
la vue actuelle.
Réglage de la hauteur des pistes de la Timeline
Outre la possibilité d’effectuer un zoom dans la Timeline, vous pouvez également 
régler la hauteur des pistes. Il est possible de redimensionner séparément les pistes 
audio et d’objets. Certaines pistes, tels que les filtres ou les comportements, ne peuvent 
pas être redimensionnées.
Curseur de zoom Commande Zoom/Défilement
Case de défilement Poignée362 Chapitre 4 Utilisation de la Timeline
Pour régler la hauteur des pistes, procédez de l’une des manières suivantes :
m Faites glisser la ligne de séparation située entre deux couches dans la liste de couches 
de la Timeline. Lorsque le pointeur se transforme en pointeur d’ajustement, faites-la 
glisser vers le haut ou vers le bas afin de modifier la hauteur des couches.
m Cliquez sur l’un des boutons « Définir la hauteur de ligne de la Timeline ».
Spécification de l’affichage des pistes
Vous pouvez choisir parmi plusieurs méthodes pour afficher les objets situés dans 
les pistes de la Timeline. Vous pouvez choisir de n’afficher que le nom de l’objet situé 
dans la piste, ce qui permet d’affiner la piste afin de pouvoir afficher aisément plusieurs pistes à la fois. Vous pouvez choisir d’afficher le nom et une vignette de l’objet, 
ce qui fournit un aperçu rapide et vous permet de savoir exactement à quoi correspond chaque objet. Vous pouvez également afficher les pistes sous la forme d’une pellicule, afin de pouvoir afficher une série de vignettes pour identifier les points de 
transformation d’un objet film. Toute modification du réglage d’affichage d’une piste 
modifie l’affichage des pistes de masque et d’image dans la Timeline.
Pour spécifier le mode d’affichage d’une piste :
1 Choisissez Motion > Préférences pour ouvrir la fenêtre des préférences.
2 Cliquez sur l’icône Apparence.
3 Dans la section réservée à la Timeline, choisissez une option dans le menu local Affichage 
de la barre de temps.
4 Cliquez sur la case de fermeture de la fenêtre pour fermer la fenêtre des préférences. 
Les barres sont affichées en fonction de votre choix.
Remarque : lorsque Affichage de la barre de temps est défini sur Pellicule, le temps de 
traitement est augmenté. Si un filtre est appliqué à une couche ou un groupe, le résultat 
de ce filtre apparaît dans la pellicule.Chapitre 4 Utilisation de la Timeline 363
Utilisation de la Timeline
La Timeline constitue l’un des éléments les plus flexibles et précieux de l’interface de 
Motion. C’est là que vous pouvez contrôler tous les aspects temporels de votre projet. 
Que ce soit pour aligner plusieurs couches afin qu’elles débutent ou terminent ensemble, 
pour modifier la portion à utiliser dans un plan ou pour rallonger ou raccourcir un objet 
particulier, la Timeline dispose toujours des outils dont vous avez besoin. 
Vous pouvez utiliser la Timeline afin d’ajouter des images et des plans à votre projet, 
comme lorsque vous ajoutez des fichiers à la liste de couches ou au Canevas. Vous 
pouvez faire glisser des objets dans la liste de couches de la Timeline ou les faire glisser directement dans des pistes de la Timeline. Faire glisser des éléments dans les pistes de la Timeline fournit des options de montage supplémentaires telles que le 
compositing, l’insertion, l’écrasement et le remplacement des plans.
Cette section décrit toutes ces fonctions et explique comment les ajouter, les supprimer 
et les réordonner.
Ajout d’objets dans la Timeline
Lorsque vous faites glisser un nouvel objet vers la Timeline, un menu déroulant apparaît 
pour vous permettre d’indiquer comment incorporer cet objet au projet. Une fois cet 
objet ajouté au projet à l’aide de la Timeline, il apparaît dans la liste de couches et devient 
une piste dans la Timeline. Vous pouvez alors effectuer un montage composite de ce 
nouvel objet sur des objets existants (au-dessus des couches existantes), l’insérer dans 
une piste existante, l’utiliser pour écraser un objet ou pour remplacer les médias d’un 
objet existant.
Remarque : vous pouvez également faire glisser des caméras et des lumières enregistrées 
dans la Bibliothèque vers la Timeline.364 Chapitre 4 Utilisation de la Timeline
Différentes options vous sont proposées en fonction de l’endroit où vous déposez l’objet 
dans la Timeline. Si vous faites glisser l’élément vers la piste d’un groupe ou d’un objet, 
vous avez le choix entre Composite, Insérer ou Écraser. L’option supplémentaire Échanger n’est disponible que si vous faites glisser le même type de média vers une piste. Par 
exemple, Échanger apparaît si vous faites glisser une séquence QuickTime vers la piste 
d’une séquence QuickTime. Le nouvel objet peut apparaître au-dessus ou au-dessous 
d’un objet. L’emplacement où vous relâchez le bouton de la souris détermine le positionnement du nouvel objet.
Remarque : vous n’êtes autorisé à utiliser l’option Échanger que pour échanger 
le même type de média (tel qu’une séquence QuickTime, une séquence d’images ou 
un fichier d’image). Par exemple, l’option Échanger n’est pas disponible lorsque vous faites glisser un générateur ou une forme de la Bibliothèque sur une séquence d’images.
Si vous supprimez plusieurs objets, vous pouvez choisir Composite ou Séquentiel 
dans le menu déroulant. Le mode Séquentiel importe les objets l’un après l’autre.
Remarque : si vous relâchez le bouton de la souris avant que le menu déroulant 
n’apparaisse, le choix par défaut (Composite) est appliqué. En d’autres termes, 
la nouvelle couche apparaît au-dessus de tous les autres objets dans le Canevas.
Composite
Si vous optez pour Composite, le nouvel objet est ajouté à une nouvelle piste au sein 
du groupe activé et toutes les couches demeurent simultanément à l’écran. 
Glissement vers la piste d’un groupe Glissement au sein de la piste d’un objet
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Insérer
Lorsque vous choisissez Insérer, Motion laisse l’objet existant sur la piste, mais le pousse 
en avant dans le temps afin de faire de la place pour le nouvel objet. Ainsi, si vous insérez 
une séquence composée de cinq images dans un groupe contenant déjà un objet, 
la nouvelle séquence est ajoutée dans la Timeline au niveau de l’image sur laquelle vous 
la déposez et les autres images de la séquence d’origine sont décalées de cinq images.
Si vous insérez un objet au milieu d’un objet, ce dernier est scindé en deux objets ayant 
chacun sa propre piste.
Écraser
L’option Écraser supprime l’objet et le remplace par le nouvel objet.
Si le nouvel objet est plus court que l’objet déjà présent au sein du groupe, l’option 
Écraser divise la durée de l’objet existant et ne supprime que les images situées 
à l’emplacement du nouvel objet. 
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Échanger
L’option Échanger est une variante de l’option Écraser, mais plutôt que de déposer toute 
la durée du nouvel objet dans le projet, seule la durée de l’objet existant est utilisée.
Ainsi, si vous déposez un plan de 30 secondes sur un plan de 5 secondes, l’option Échanger 
permet de remplacer les 5 secondes par les 5 premières secondes du plan le plus long.
De même, si vous essayez de remplacer un plan de 10 secondes par un plan qui ne 
dure que 5 secondes, les 5 premières secondes sont remplacées et les 5 secondes 
restantes demeurent intactes. L’option Échanger transfère tous les filtres, comportements et images clés éventuels de l’objet original vers le nouvel objet.
Remarque : il est impossible d’utiliser l’option Échanger avec des fichiers audio.
Séquentiel
Cette option du menu déroulant est disponible uniquement lorsque vous supprimez 
plusieurs objets dans la Timeline. Le mode Séquentiel dépose les objets l’un après 
l’autre dans la Timeline. Pour plus d’informations, voir « Ajout de plusieurs plans à la 
Timeline » à la page 368.
Pour effectuer un montage composite sur un objet : 
1 Faites glisser un objet depuis la Bibliothèque ou l’onglet Média jusque dans la zone 
des pistes de la Timeline.
Pendant que vous faites glisser l’objet, une bulle d’aide apparaît au niveau du pointeur 
pour indiquer le numéro de l’image où vous vous situez.
2 Dès que vous avez atteint l’image sur laquelle vous souhaitez faire débuter la nouvelle 
couche, placez le pointeur sur la couche à utiliser comme arrière-plan et maintenez 
enfoncé le bouton de la souris jusqu’à ce que le menu déroulant apparaisse.
3 Choisissez Composite dans le menu déroulant. 
Un montage composite est alors effectué dans le projet avec la nouvelle couche.
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Pour insérer un objet :
1 Faites glisser un objet depuis la Bibliothèque ou l’onglet Média vers la zone réservée 
aux pistes dans la Timeline.
Pendant que vous faites glisser l’objet, une bulle d’aide apparaît au niveau du pointeur 
pour indiquer le numéro de l’image où vous vous situez.
2 Une fois que vous avez atteint l’image où vous souhaitez faire débuter le nouvel objet, 
gardez le bouton de la souris enfoncé jusqu’à ce que le menu déroulant apparaisse.
3 Choisissez Insérer dans le menu déroulant.
Le nouvel objet est inséré dans la piste, divisant la barre originale en deux et repoussant 
plus en avant dans le temps les images situées après le point d’insertion. 
Pour écraser un objet :
1 Faites glisser un objet depuis la Bibliothèque ou l’onglet Média vers la zone réservée 
aux pistes dans la Timeline.
Pendant que vous faites glisser l’objet, une bulle d’aide apparaît pour indiquer 
le numéro de l’image où vous vous situez.
2 Dès que vous avez atteint l’image sur laquelle vous souhaitez faire débuter le nouvel 
objet, maintenez enfoncé le bouton de la souris jusqu’à ce que le menu déroulant 
apparaisse.
3 Choisissez Écraser dans le menu déroulant.
Les images du nouvel objet remplacent celles de l’objet original. Si l’objet original 
contient plus d’images que le nouvel objet, l’ancien objet est divisé en deux objets 
et les images supplémentaires sont conservées.
Pour échanger un objet :
1 Faites glisser un objet depuis la Bibliothèque ou l’onglet Média vers la zone réservée 
aux pistes dans la Timeline.
Pendant que vous faites glisser l’objet, une bulle d’aide apparaît pour indiquer 
le numéro de l’image où vous vous situez.
2 Dès que vous avez atteint l’objet que vous souhaitez échanger, maintenez enfoncé 
le bouton de la souris jusqu’à ce que le menu déroulant apparaisse.
3 Choisissez Échanger dans le menu déroulant.
L’ancien objet est remplacé par le nouvel objet.368 Chapitre 4 Utilisation de la Timeline
Ajout de plusieurs plans à la Timeline
Lorsque vous faites glisser plusieurs éléments vers la Timeline, les nouveaux objets apparaissent sur leur propre piste au-dessus de tous les objets existants. Cela revient à effectuer 
un montage composite à l’aide d’un seul objet. Un menu déroulant vous permet de décider si les objets supplémentaires doivent être empilés pour former un montage composite 
ou s’ils doivent apparaître l’un après l’autre (de manière séquentielle).
Pour ajouter plusieurs objets sous la forme d’un montage composite :
1 Sélectionnez des fichiers dans la Bibliothèque ou l’onglet Média tout en maintenant 
la touche Maj enfoncée, puis faites-les glisser vers la zone réservée aux pistes dans 
la Timeline. 
2 Dès que vous avez atteint l’image sur laquelle vous souhaitez faire débuter les nouveaux 
objets, maintenez enfoncé le bouton de la souris jusqu’à ce que le menu déroulant 
apparaisse.
3 Choisissez Composite dans le menu déroulant.
Tous les objets sont alors montés dans le projet, au même moment dans le temps, 
chacun sur sa propre piste. 
Vous pouvez également déposer tous les objets dans la liste de couches de la Timeline. 
Dans ce cas, vous obtenez toujours un montage composite. Si vous relâchez le bouton 
de la souris avant que le menu déroulant n’apparaisse, un montage composite 
est appliqué.
Pour ajouter plusieurs objets de manière séquentielle :
1 Sélectionnez des fichiers dans le Navigateur, la Bibliothèque ou l’onglet Média tout en 
maintenant la touche Commande enfoncée, puis faites-les glisser vers la zone réservée 
aux pistes dans la Timeline. 
2 Dès que vous avez atteint l’image sur laquelle vous souhaitez faire débuter les nouveaux 
objets, maintenez enfoncé le bouton de la souris jusqu’à ce que le menu déroulant 
apparaisse.
3 Choisissez Séquentiel dans le menu déroulant.
Tous les objets sont montés dans le projet, l’un après l’autre, chacun sur sa propre piste. 
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Réglage des préférences de l’action glisser-déposer
Vous pouvez définir des préférences déterminant l’emplacement de dépôt d’un élé-
ment lorsque vous le faites glisser dans la liste de couches de la Timeline. Vous pouvez 
choisir entre déposer des éléments au début du projet ou à l’emplacement actuel de 
la tête de lecture. Vous pouvez également définir la durée s’écoulant avant l’apparition 
du menu déroulant.
Pour spécifier l’emplacement des nouveaux objets dans la Timeline :
1 Choisissez Motion > Préférences.
La fenêtre Préférences s’ouvre.
2 Cliquez sur l’icône Projet. 
Les préférences Projet apparaissent dans la fenêtre.
3 Dans la section Images et couches, cliquez sur le bouton approprié pour créer 
les couches « Sur l’image actuelle » ou « Au début du projet ». 
Remarque : la préférence « Créer couches à » s’applique uniquement lorsque vous faites 
glisser des éléments vers la liste de couches de la Timeline ou de la sous-fenêtre du projet, 
ou directement sur le Canevas. Les plans déposés sur une image spécifique au sein 
de la Timeline apparaissent toujours à cet emplacement exact.
Pour régler la préférence relative au délai du menu déroulant:
1 Choisissez Motion > Préférences.
La fenêtre Préférences s’ouvre.
2 Cliquez sur l’icône Générales pour accéder aux préférences d’ordre général.
3 Dans la section Interface, faites glisser le curseur « Délai menu déroulant » pour définir 
le délai qui s’écoule avant l’apparition du menu déroulant.
Ajout à la liste de couches de la Timeline
Vous pouvez faire glisser une image depuis le Navigateur ou l’onglet Média vers la 
liste de couches de la Timeline. Vous avez alors le choix entre ajouter ce nouvel objet 
à un groupe existant, remplacer un objet présent ou créer un nouvel objet.
Pour ajouter un objet à un groupe existant :
1 Faites glisser un objet depuis le Navigateur, la Bibliothèque ou l’onglet Média, 
puis placez le pointeur sur la liste de couches de la Timeline.
Â Si vous positionnez le pointeur sur un groupe, une bordure noire apparaît autour 
de la piste correspondante. 
Â Si vous placez le pointeur entre des pistes d’objets au sein d’un groupe, l’indicateur 
de position apparaît. 
2 Relâchez le bouton de la souris pour ajouter la couche au groupe.
La nouvelle couche est placée soit au-dessus de tous les autres objets du groupe, 
soit entre les objets à l’endroit où vous l’avez déposée.370 Chapitre 4 Utilisation de la Timeline
Pour remplacer un objet dans un groupe existant :
1 Faites glisser un objet depuis le navigateur, la Bibliothèque ou l’onglet Média, 
puis placez le pointeur sur l’objet à remplacer.
Un cadre de surbrillance noir apparaît autour de l’objet.
Remarque : la commande Remplacer ne peut être utilisée qu’avec les images, 
les séquences d’images et les séquences QuickTime.
2 Relâchez le bouton de la souris.
Le nouvel objet remplace l’ancien. 
Pour créer un nouveau groupe au-dessus des groupes existants :
1 Faites glisser un objet depuis le Navigateur, la Bibliothèque ou l’onglet Média vers 
la liste de couches de la Timeline, à la limite supérieure de l’objet situé tout en haut.
2 Dès que l’indicateur de position apparaît, relâchez le bouton de la souris. 
Un nouveau groupe est créé au-dessus de tout autre groupe présent dans la hiérarchie, 
encore appelée « pile » des groupes et des couches.
Pour créer un nouveau groupe en dessous des groupes existants :
1 Faites glisser un objet depuis le Navigateur, la Bibliothèque ou l’onglet Média vers 
la liste de couches de la Timeline, sous la limite inférieure de l’objet situé tout en bas.
Remarque : il existe deux indicateurs de position différents. Le plus court place l’objet 
dans le groupe existant. Tout en maintenant le bouton de la souris enfoncé, déplacez 
le pointeur légèrement vers la gauche pour afficher l’indicateur le plus long. Cet indicateur crée un nouveau groupe.
2 Relâchez le bouton de la souris.
Un nouveau groupe est créé en dessous de tous les autres groupes présents dans 
la hiérarchie, encore appelée « pile » des groupes et des objets.
Gestion de l’ordre des pistes
La liste de couches de la Timeline met à votre disposition tous les outils nécessaires 
pour contrôler l’ordre des objets. Dans Motion, la piste la plus haute de la liste apparaît 
au-dessus des autres couches dans le Canevas. Cela signifie que vous devez peut-être 
réordonner l’ordre des objets de votre projet afin d’obtenir les effets souhaités. Chapitre 4 Utilisation de la Timeline 371
Pour réorganiser les objets au sein d’un groupe :
1 Dans la liste de couches de la Timeline, cliquez sur l’icône de l’objet à déplacer. 
2 Faites-le glisser à l’endroit souhaité entre d’autres pistes.
3 Lorsque l’indicateur de position apparaît à l’endroit souhaité, relâchez le bouton 
de la souris.
Les pistes sont alors réordonnées.
Pour déplacer un objet d’un groupe existant vers un autre :
1 Dans la liste de couches de la Timeline, faites glisser l’icône de l’objet vers 
un autre groupe. 
Une bordure noire met en évidence le groupe choisi. 
2 Relâchez le bouton de la souris.
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L’objet est déplacé dans le groupe sélectionné et placé au-dessus de tous les objets 
préalablement présents dans ce groupe.
Vous pouvez également déposer un objet à un emplacement spécifique du nouveau 
groupe en le faisant glisser entre les pistes de ce nouveau groupe. Dans Motion, 
les groupes et les couches sont à « ouverture automatique ». En d’autres termes, 
ils sont temporairement développés, tout comme les dossiers sur le Finder, lorsque 
vous faites glisser un objet à l’intérieur. 
Pour déposer un objet dans un groupe réduit:
1 Dans la liste de couches de la Timeline, faites glisser l’objet vers le groupe réduit.
2 Placez le pointeur au-dessus du nom du groupe jusqu’à ce que le groupe s’ouvre 
automatiquement.
3 Faites glisser l’objet à l’emplacement souhaité au sein du groupe, puis relâchez 
le bouton de la souris.
Imbrication de groupes et de couches
Pour vous aider à organiser des groupes contenant de nombreux objets ou à créer 
certains types d’effets spéciaux, vous avez la possibilité de placer des groupes au sein 
d’autres groupes. Cette possibilité vous offre toute la souplesse nécessaire pour créer 
un groupe contenant un grand nombre d’objets et traiter ce groupe comme s’il s’agissait 
d’un seul objet au sein d’un autre groupe. Il est même possible d’aller encore plus loin 
en prenant le groupe « parent », en le combinant avec d’autres groupes et en le traitant 
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Plusieurs raisons peuvent vous amener à choisir d’imbriquer vos couches ou vos groupes. 
Cela vous permet de simplifier votre montage composite en regroupant les objets et 
les couches dans un nombre plus réduit de conteneurs. Cela vous permet également 
de manipuler un groupe d’objets comme s’il s’agissait d’un groupe unique. Vous pourriez, 
par exemple, prendre chaque lettre de votre titre (chacune disposant de sa propre 
animation) et utiliser l’imbrication pour animer le groupe de lettres à travers l’écran. 
Vous pouvez également utiliser l’imbrication pour créer des systèmes complexes 
de particules. Vous pouvez imbriquer plusieurs objets en une couche et utiliser la couche 
entière comme cellule émettrice. Pour en savoir plus sur les systèmes de particules, 
voir « Utilisation des particules » à la page 743.
Remarque : il vous est impossible d’utiliser la commande Grouper avec des objets 
situés dans des groupes différents.
Pour imbriquer un groupe dans un autre :
1 Dans la liste de couches de la Timeline, faites glisser l’icône d’un groupe vers le groupe 
au sein duquel vous souhaitez l’imbriquer.
Une bordure noire met en évidence le groupe de destination choisi.
2 Relâchez le bouton de la souris.
Le premier groupe est désormais imbriqué dans le second.
Vous pouvez également sélectionner les objets à imbriquer, puis choisir Objet > 
Grouper (ou appuyer sur les touches Commande + Maj + G).
Remarque : le nombre de groupes que vous pouvez imbriquer est illimité. 
Pour annuler l’imbrication d’un groupe :
m Sélectionnez le groupe imbriqué, puis choisissez Objet > Dissocier (ou appuyez sur 
les touches Commande + Option + G). 
Le groupe imbriqué est restauré en objets individuels. Tout groupe situé au sein 
d’un autre groupe peut être dissocié.
Pour supprimer un groupe au sein d’une imbrication :
1 Cliquez sur l’icône du groupe dans la liste de couches de la Timeline.
2 Faites glisser le groupe en dehors du groupe parent et jusque vers la zone située 
au-dessus de la piste la plus haute. 
L’indicateur de position apparaît. 
3 Relâchez le bouton de la souris.
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Pour supprimer la piste d’un groupe ou d’un objet :
1 Sélectionnez le groupe ou l’objet dans la liste de couches de la Timeline.
2 Appuyez sur la touche Suppr.
Vous pouvez également cliquer sur un objet en maintenant la touche Contrôle enfoncée, 
puis choisir Supprimer dans le menu contextuel.
Toutes les opérations décrites ci-dessus peuvent être effectuées avec plusieurs pistes. 
Par exemple, au lieu de simplement déplacer un objet du Groupe 1 vers le Groupe 3, 
vous pouvez sélectionner deux ou trois objets du Groupe 1 et les déplacer simultanément.
Pour sélectionner plusieurs pistes d’objets ou de groupes :
m Dans la liste de couches, cliquez sur chacune des pistes à inclure dans votre sélection 
tout en maintenant la touche Commande enfoncée.
Scission de pistes
Il peut parfois s’avérer utile de diviser un objet en plusieurs objets, chacun disposant de 
sa propre piste dans la Timeline. Vous pouvez avoir envie de procéder de la sorte si vous 
souhaitez appliquer un effet à une seule partie d’un plan ou modifier en plein au milieu 
l’ordre de la couche d’un objet, afin de créer l’illusion que les objets se déplacent dans 
un espace tridimensionnel. Lorsque vous travaillez en 3D, vous pouvez même scinder 
les pistes des caméras. La scission des pistes vous permet de transformer un objet en plusieurs parties que vous pouvez ensuite manipuler individuellement sur leur propre piste.
Pour scinder une piste d’objet :
1 Sélectionnez l’objet à scinder dans la zone réservée aux pistes de la liste de couches 
de la Timeline.
2 Placez la tête de lecture sur l’image correspondant à l’endroit où vous souhaitez 
effectuer la scission.
3 Choisissez Édition > Scinder. 
L’objet est alors divisé en deux parties, chacune étant placée sur sa propre piste.
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Modification d’objets dans la Timeline
Lors du processus de conception et de mise en œuvre d’un projet d’animation, 
vous pouvez placer des objets dans la Timeline et le Canevas, les faire avancer 
ou reculer dans le temps et leur appliquer des Trim afin de les faire coïncider 
avec la durée d’autres objets de votre projet. 
Motion comprend plusieurs fonctions qui vous aident à modifier des objets dans 
la Timeline. Vous pouvez, par exemple, disposer vos objets afin qu’ils commencent 
et finissent sur les images de votre choix. De puissants outils de contrôle du temps 
et d’alignement, tels que le magnétisme et les marqueurs, sont également disponibles. 
La Timeline vous permet aussi de modifier les images clés. Cette section traite 
des différentes méthodes d’exécution de ces opérations.
Dans Motion, les termes déplacer, Trim et coulisser font référence aux méthodes utilisées 
pour modifier des objets de la Timeline.
Déplacer : modifie l’emplacement d’un objet sans en modifier le contenu ni la durée.
Trim : modifie la durée d’un objet sans en modifier l’emplacement ni le contenu. 
Coulisser : modifie l’emplacement d’un objet sans en modifier le contenu ni la durée.
Déplacement d’objets
Déplacez un objet lorsque vous voulez qu’il débute et termine à un endroit différent 
du projet.
Pour déplacer un objet :
m Dans la zone réservée aux pistes, cliquez sur la barre d’un objet, puis faites-la glisser 
vers la gauche ou la droite pour déplacer cet objet dans le temps. 
Au fur et à mesure que vous faites glisser l’objet, une bulle d’aide vous indique les nouveaux 
points d’entrée et de sortie du plan, de telle sorte que vous puissiez déposer l’objet exactement sur l’image souhaitée. Le symbole Delta (le petit triangle) indique le nombre d’images 
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Pour déplacer un objet et le caler par magnétisme sur les éléments voisins :
m Maintenez la touche Maj enfoncée tandis que vous faites glisser l’élément dans 
la Timeline. 
Les lignes magnétiques apparaissent et les bords du plan s’alignent automatiquement 
et de manière précise sur ces lignes.
Déplacement d’objets sur la tête de lecture
Dans la Timeline, vous pouvez déplacer un objet vers un nouvel emplacement grâce 
à la commande Déplacer le point d’entrée (ou de sortie) sélectionné. Cette commande 
décale automatiquement la position de l’objet sélectionné vers la position actuelle 
de la tête de lecture. Elle peut également servir à déplacer et aligner plusieurs objets 
en une seule fois.
Pour déplacer un objet vers la tête de lecture :
1 Sélectionnez l’objet à déplacer.
2 Dans la Timeline, positionnez la tête de lecture sur le point vers lequel vous souhaitez 
déplacer l’objet.
3 Choisissez soit Marquer > Déplacer le point d’entrée sélectionné (ou appuyez sur 
les touches Maj + crochet ouvrant) pour aligner le début de l’objet sur la position 
de la tête de lecture soit Marquer > Déplacer le point de sortie sélectionné (ou Maj + 
crochet fermant) pour aligner sa fin sur cette même position.
Trim d’objets
Appliquez un Trim à un objet lorsque vous souhaitez réduire ou prolonger sa durée 
dans la Timeline. Vous pouvez raccourcir ou allonger le début ou la fin d’un objet en 
faisant glisser le bord gauche ou le bord droit (points d’entrée et de sortie) de la barre 
de l’objet dans la Timeline. 
Vous pouvez également appliquer le Trim à un plan à l’aide de commandes de menu 
et des raccourcis clavier correspondants, afin de modifier les points d’entrée et de 
sortie de l’objet. Ces méthodes vous permettent de traiter plusieurs objets en même 
temps et d’effectuer des opérations de Trim à la volée alors que votre projet est en 
cours de lecture.
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Seule la couche d’une séquence dont le média source contient des images inutilisées 
peut être rallongée. Si vous devez étendre un objet dont les données source ne contiennent pas assez d’images, vous pouvez toutefois modifier sa Condition de fin avec 
les valeurs En boucle, Ping-Pong ou Suspendre. Pour accéder au paramètre Condition 
de fin, ouvrez l’onglet Propriétés de l’Inspecteur. Vous n’êtes aucunement limité 
si vous souhaitez étendre la longueur d’autres objets, tels que des caméras, du texte 
ou des formes.
Remarque : pour en savoir plus sur les commandes Contrôle du temps, 
voir « Resynchronisation » à la page 345. 
Lorsque vous redimensionnez un plan, les images inutilisées apparaissent temporairement dans une couleur plus claire au-delà des limites de l’objet. S’il ne reste plus 
de place au-delà de la portion actuellement utilisée du plan, aucune image inutilisée 
n’apparaît et vous ne pouvez pas rallonger le plan. 
Pour effectuer un Trim sur un plan :
1 Placez le pointeur sur l’une des extrémités du plan à traiter. 
Le pointeur se transforme alors en pointeur de Trim. 
2 Faites glisser l’extrémité de la barre jusqu’à ce qu’elle atteigne l’image sur laquelle 
vous souhaitez faire débuter ou terminer le plan. 
À mesure que vous faites glisser la barre, une bulle d’aide apparaît pour afficher 
le nouveau point d’entrée ou de sortie, ainsi que la nouvelle durée du plan.
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Pour effectuer un Trim sur un objet et le caler par magnétisme sur des éléments 
avoisinants :
m Maintenez la touche Maj enfoncée tandis que vous faites glisser le bord de l’élément 
dans la Timeline.
Les lignes magnétiques apparaissent et le bord du plan que vous faites glisser s’aligne 
automatiquement et de manière précise sur ces lignes.
Pour modifier les points d’entrée ou de sortie d’un objet :
1 Sélectionnez l’objet sur lequel vous souhaitez effectuer le Trim.
2 Placez la tête de lecture sur l’image correspondant à l’endroit où vous souhaitez placer 
le nouveau point d’entrée ou de sortie.
3 Choisissez soit Marquer > Point d’entrée (ou appuyez sur la touche I) pour définir 
le nouveau point d’entrée, soit Marquer > Point de sortie (ou appuyez sur la touche O) 
pour changer de point de sortie.
Pour effectuer un Trim sur plusieurs objets à la fois :
1 Sélectionnez les objets à traiter.
2 Placez la tête de lecture sur le point d’entrée ou de sortie souhaité.
3 Choisissez soit Marquer > Point d’entrée (ou appuyez sur la touche I) pour définir 
le nouveau point d’entrée, soit Marquer > Point de sortie (ou appuyez sur la touche O) 
pour définir le nouveau point de sortie. 
Le Trim est appliqué sur tous les objets jusqu’au nouveau point. 
Remarque : si l’un des objets ne possède pas assez de médias pour effectuer le Trim, 
il est déplacé aussi loin que possible vers le point souhaité.
Coulissement de plans
Vous devez faire coulisser un plan dès lors que vous souhaitez utiliser une autre partie 
de ce plan sans modifier la durée de la couche ou son emplacement dans la Timeline. 
Le coulissement n’est possible qu’après avoir effectué un Trim sur le plan.
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Si vous disposez par exemple d’un plan de 3 secondes montrant une porte qui s’ouvre 
et que vous l’avez réduit à 1 seconde à l’aide du Trim, vous pouvez utiliser la fonction 
Coulisser pour sélectionner la seconde à utiliser : la première seconde montrant la porte 
s’écarter du chambranle, la seconde suivante montrant la porte s’ouvrir davantage 
ou la dernière seconde montrant la porte claquer contre le mur.
Remarque : vous ne pouvez faire coulisser un plan que dans la mesure où il existe 
des images inutilisées dans le média source.
Pour faire coulisser un plan :
1 Placez le pointeur au-dessus du plan, puis appuyez sur la touche Option et maintenez-la 
enfoncée.
Le pointeur se transforme alors en pointeur de coulissement.
2 Faites glisser la partie centrale de la barre de couleur vers la gauche ou la droite. 
Le glissement vers la droite remplace les images par une section provenant des données 
sources ultérieures, tandis que le glissement vers la gauche utilise les images antérieures 
dans le plan.
Suppression d’objets
La suppression d’objets de votre projet peut s’avérer aussi importante que leur ajout. 
Dans Motion, vous disposez de trois méthodes pour supprimer un objet de la Timeline.
Supprimer : supprime l’objet tout en laissant un vide dans la Timeline.
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Supprimer Ripple : supprime l’objet et bouche le vide laissé par cette suppression. 
Si ’objet est contenu dans un groupe, ce groupe est scindé en deux objets.
Couper : supprime l’objet tout en laissant un vide dans la Timeline et copie cet objet 
dans le Presse-papiers d’où il pourra être collé ultérieurement.
Pour supprimer un objet :
1 Sélectionnez l’objet à supprimer.
2 Choisissez Édition > Supprimer (ou appuyez sur la touche de suppression).
Vous pouvez également cliquer sur l’objet en maintenant la touche Contrôle enfoncée, 
puis choisir Supprimer dans le menu contextuel.
Pour effectuer la commande Supprimer Ripple sur un objet :
1 Sélectionnez l’objet à supprimer.
2 Choisissez Édition > Supprimer Ripple (ou appuyez sur les touches Maj + Supprimer).
Pour couper un objet :
1 Sélectionnez un objet à supprimer.
2 Choisissez Édition > Couper dans la barre des menus (ou appuyez sur les touches 
Commande + X).
Vous pouvez également cliquer sur l’objet en maintenant le bouton Contrôle enfoncé, 
puis choisir Couper dans le menu contextuel.
Copier et coller
Comme dans d’autres applications, vous avez la possibilité de copier un objet. 
Cette opération laisse l’objet en place et le copie dans le Presse-papiers d’où il pourra 
être ultérieurement collé. 
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Lorsque vous collez un objet, il est placé à l’endroit correspondant à la position de 
la tête de lecture. 
Si une couche est sélectionnée, l’objet est collé dans cette couche, au-dessus de tous 
les autres objets. Dans le cas contraire, une nouvelle couche est créée pour l’objet collé 
(comme illustré ci-dessus).
Pour changer la piste activée, cliquez sur une autre piste dans la liste de couches de 
la Timeline. Le collage de plusieurs objets conserve l’ordre relatif des objets et des 
couches du contenu du Presse-papiers. De nouvelles couches peuvent être ajoutées 
afin de permettre l’opération de collage. 
Les objets dotés de filtres, de comportements, d’images clés et d’autres effets conservent 
ces effets lorsqu’ils sont coupés, copiés et collés.
Pour copier un objet dans le Presse-papiers :
1 Dans la liste de couches de la Timeline ou le Navigateur, sélectionnez le ou les objets 
que vous souhaitez copier.
2 Choisissez Édition > Copier (ou appuyez simultanément sur les touches Commande + C).
Pour coller un objet :
1 Dans la liste de couches de la Timeline, sélectionnez la couche dans laquelle vous 
souhaitez coller l’objet.
2 Placez la tête de lecture sur l’endroit correspondant à la position voulue dans le temps.
3 Choisissez Édition > Coller (ou appuyez simultanément sur les touches Commande + V).
Collage spécial
Outre les fonctions de collage ordinaires, Motion vous permet de coller un élément 
par insertion, écrasement ou échange. Ces trois commandes apparaissent dans la zone 
de dialogue Collage spécial. Le Collage spécial peut être associé aux régions pour 
effectuer un type spécial de collage. Pour plus d’informations, voir « Collage dans » à 
la page 397.
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Insérer : colle le contenu du Presse-papiers dans le projet, en repoussant les objets 
plus loin dans le temps.
Écraser : colle le contenu du Presse-papiers dans le projet, en supprimant tout objet 
au même point dans le temps.
Échanger : remplace l’objet sélectionné dans le projet par le contenu du Presse-papiers. 
Pour coller un objet par insertion :
1 Sélectionnez la piste dans laquelle vous souhaitez coller l’objet.
2 Placez la tête de lecture sur l’endroit correspondant à la position voulue dans le temps.
3 Choisissez Édition > Collage spécial (ou appuyez simultanément sur les touches 
Option + Commande + V). 
La zone de dialogue Collage spécial apparaît.
4 Sélectionnez « Insérer dans la zone de temps ».
5 Cliquez sur OK pour confirmer votre action.
Pour coller un objet par écrasement :
1 Sélectionnez la piste dans laquelle vous souhaitez coller l’objet.
2 Placez la tête de lecture sur l’endroit correspondant à la position voulue dans le temps.
3 Choisissez Édition > Collage spécial (ou appuyez simultanément sur les touches 
Option + Commande + V). 
La zone de dialogue Collage spécial apparaît.
4 Sélectionnez « Écraser dans la zone de temps ».
5 Cliquez sur OK pour confirmer votre action.
Pour coller un objet en tant qu’échange :
1 Sélectionnez la piste dans laquelle vous souhaitez coller l’objet.
2 Placez la tête de lecture sur l’endroit correspondant à la position voulue dans le temps.
3 Choisissez Édition > Collage spécial (ou appuyez simultanément sur les touches 
Option + Commande + V). 
La zone de dialogue Collage spécial apparaît.
4 Sélectionnez « Échanger le média avec l’objet existant ».
5 Cliquez sur OK pour confirmer votre action.
Remarque : l’option « Échanger le média avec l’objet existant » n’est disponible 
qu’avec les éléments copiés dans le Navigateur. Pour copier une image dans 
le Navigateur, sélectionnez-la, puis choisissez Édition > Copier (ou appuyez 
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Affichage et modification d’images clés dans la Timeline
Vous pouvez déplacer ou supprimer les images clés affichées dans la Timeline. 
Vous avez également la possibilité d’y afficher la courbe d’animation d’une image 
clé sélectionnée grâce à l’Éditeur d’images clés.
Pour afficher les images clés dans la Timeline :
m En bas de la liste de couches de la Timeline, cliquez sur le bouton Afficher/Masquer 
les images clés.
Lorsque le bouton apparaît en gris foncé, il est activé. Les images clés apparaissent 
sous les pistes des objets. Dans l’exemple suivant, l’objet « étoile à 5 branches » comporte trois images clés. Elles sont affichées dans la piste située en dessous de l’objet.
Pour déplacer la position d’une image clé dans le temps :
m Faites glisser l’image clé vers la gauche ou la droite. Une fois sélectionnée, une image 
clé apparaît en blanc.
Le déplacement de l’image clé dans la Timeline modifie uniquement sa position dans 
le temps. Pour changer directement la valeur d’une image clé, procédez de l’une des 
manières suivantes :
Â Cliquez sur l’image clé tout en maintenant la touche Contrôle enfoncée, choisissez 
la propriété que vous souhaitez modifier dans le menu contextuel, saisissez une 
nouvelle valeur, puis appuyez sur Retour.
Â Utilisez l’Éditeur d’images clés. Vous pouvez ainsi modifier la valeur et l’interpolation 
de l’image clé. Pour en savoir plus sur l’Éditeur d’images clés, voir « Images et clés et 
courbes » à la page 547.
Pour supprimer une image clé ou un groupe d’images clés sélectionnées :
m Sélectionnez la ou les images clés que vous souhaitez supprimer, puis procédez 
de l’une des manières suivantes :
Â Appuyez sur la touche Suppr.
Â Cliquez sur les images clés sélectionnées en maintenant la touche Contrôle enfoncée, 
puis choisissez Supprimer les images clés dans le menu contextuel.
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Pour supprimer toutes les images clés :
m Cliquez sur l’image clé en maintenant la touche Contrôle enfoncée, puis choisissez 
Supprimer toutes les images clés dans le menu contextuel.
Pour afficher une courbe d’animation dans l’Éditeur d’images clés :
m En maintenant la touche Contrôle enfoncée, cliquez sur l’image clé dans la piste, 
puis choisissez Afficher dans l’Éditeur d’images clés dans le menu contextuel.
L’Éditeur d’images clés est affiché, la courbe d’animation apparaît et un nouvel ensemble 
de courbes sans titre est créé. Pour plus d’informations sur les ensembles de courbes, 
consultez la rubrique « Commandes de filtrage » à la page 578.
Resynchronisation dans la Timeline
Par défaut, un plan de 60 images lu à 30 images par seconde nécessite deux secondes 
pour afficher ses 60 images. Si son point d’entrée est réglé sur l’image 1, son point 
de sortie correspond forcément à l’image 60. Sa vitesse et sa durée sont interactives. 
En d’autres termes, si vous augmentez la vitesse de lecture du plan, sa durée diminue 
automatiquement. La lecture du même plan à 15 images par seconde dure deux fois 
plus longtemps. Le point d’entrée du plan reste le même, mais son point de sortie 
correspond désormais à l’image 120.
Pour en savoir plus sur la resynchronisation, voir « Resynchronisation » à la page 345. 
Au sujet des comportements Resynchronisation, voir plutôt « Comportements 
Resynchronisation » à la page 495.
Réglage de la vitesse d’un plan
Motion vous permet de modifier en toute simplicité le contrôle du temps des plans 
dans la Timeline.
Pour accélérer un plan :
m Placez le pointeur au-dessus du début ou de la fin du plan, puis appuyez sur la touche 
Option et maintenez-la enfoncée.
Le pointeur se transforme alors en pointeur de resynchronisation.
Pour réduire la durée du plan et accélérer sa vitesse de lecture, procédez de l’une 
des manières suivantes :
Â Faites glisser le point d’entrée vers la droite sur la barre du plan.
Â Faites glisser le point de sortie vers la gauche sur la barre du plan.
À mesure que vous faites glisser, la bulle d’aide affiche la durée et la vitesse du plan.Chapitre 4 Utilisation de la Timeline 385
Pour ralentir un plan :
m Placez le pointeur au-dessus du début ou de la fin du plan, puis appuyez sur la touche 
Option et maintenez-la enfoncée.
Le pointeur se transforme alors en pointeur de resynchronisation.
Pour allonger la durée du plan et ralentir sa vitesse de lecture, procédez de l’une 
des manières suivantes :
m Faites glisser le point d’entrée vers la gauche sur la barre du plan.
m Faites glisser le point de sortie vers la droite sur la barre du plan.
À mesure que vous faites glisser, la bulle d’aide affiche la durée et la vitesse du plan.
Lecture en boucle d’un plan
Lorsque la dernière image d’un plan en boucle est atteinte, le plan reprend la lecture 
à partir de sa première image. Une autre méthode permettant d’allonger la durée d’un 
plan consiste à le lire en boucle. Pour ce faire, il vous suffit d’effectuer un réglage dans 
la Timeline.
Pour lire un plan en boucle :
1 Placez le pointeur au-dessus de la fin du plan, puis appuyez sur les touches 
Option + Maj et maintenez-les enfoncées.
Le pointeur se transforme alors en pointeur de boucle.
2 Faites glisser le point de sortie vers la gauche sur la barre de la couche.
À mesure que vous faites glisser ce point, la bulle d’aide affiche les points d’entrée et 
de sortie du plan, sa durée et la durée de la boucle. Dans la Timeline, un plan en boucle 
comporte des barrières qui indiquent où commence et se termine la boucle.
Dans la barre d’un plan, la première barrière de boucle est interactive. Si vous la déplacez, le point à partir duquel le plan est lu en bouche change.
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Pour modifier le point à partir duquel un plan est lu en boucle :
m Faites glisser la première barrière de boucle vers la gauche ou la droite.
Le point de sortie de la boucle du plan se déplace au fil du glissement de la barrière.
Montage dans la piste d’un groupe
Outre la possibilité de monter des objets individuels situés dans des groupes, Motion 
vous permet d’effectuer diverses tâches de montage directement dans la piste d’un objet, 
même si cette piste est réduite. Cela vous permet de réduire vos pistes et d’exécuter 
un grand nombre de fonctions généralement réservées aux applications de montage 
non linéaires telles que Final Cut Pro.
En règle générale, la barre du groupe vous indique le nom de l’objet, s’il est seul, et le 
nombre d’éléments ayant subi un montage composite pour les zones dans lesquelles 
plusieurs objets se chevauchent.
Déplacement d’objets dans la piste d’un groupe
Selon l’endroit où vous cliquez, Motion vous permet de déplacer des objets au sein 
d’un groupe. Vous pouvez par exemple déplacer tous les objets d’un groupe, comme 
s’il s’agissait d’un seul objet, en cliquant sur la barre bleue et étroite du groupe située 
tout en haut de la piste du groupe. Si vous cliquez sur une zone dans laquelle il n’y a 
qu’un plan, vous ne déplacez que cet élément. Si vous cliquez sur une zone dans laquelle 
plusieurs objets se chevauchent, faire glisser permet de déplacer tous les éléments 
qui se chevauchent.
Pour déplacer un groupe entier comme s’il s’agissait d’un seul objet :
1 Cliquez sur la barre bleue et étroite du groupe située tout en haut de la piste du groupe. 
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2 Faites glisser vers la droite ou vers la gauche pour déplacer toute la couche dans le temps.
Pour déplacer un seul objet au sein d’un groupe :
1 Dans la piste du groupe, cliquez sur la zone où le plan à déplacer est visible. 
Ce plan est alors mis en surbrillance dans la piste du groupe.
2 Faites glisser la section vers la gauche ou vers la droite pour déplacer l’objet au sein 
du groupe plus tôt ou plus tard dans le temps.
Raccourci de déplacement d’objets
Dans la Timeline, vous pouvez rapidement avancer ou reculer un objet d’un nombre 
spécifique d’images, ou vers une image spécifique.
Pour déplacer un objet vers une image spécifique :
1 Dans la Timeline, sélectionnez l’objet que vous souhaitez déplacer, puis tapez 
le numéro (ou timecode) de l’image vers laquelle vous souhaitez déplacer l’objet.
Avant Après
Avant Après388 Chapitre 4 Utilisation de la Timeline
Une valeur apparaît, affichant le numéro que vous avez saisi.
2 Appuyez sur la touche Retour.
Le point d’entrée de l’objet se déplace vers le numéro d’image spécifié.
Pour déplacer un objet d’un nombre spécifique d’images, effectuez l’une 
des opérations suivantes :
m Pour avancer l’objet d’un certain nombre d’images, sélectionnez l’objet, saisissez 
le signe plus (+) suivi du nombre d’images, puis appuyez sur Retour.
m Pour reculer l’objet d’un certain nombre d’images, sélectionnez l’objet, saisissez 
le signe moins (–) suivi du nombre d’images, puis appuyez sur Retour.
Pour déplacer des objets superposés au sein d’un groupe :
1 Dans la piste du groupe, cliquez sur la zone où le chevauchement est indiqué. 
La zone sélectionnée peut dépasser la zone de chevauchement si l’objet s’étend 
au-delà du chevauchement.
2 Faites glisser la section pour déplacer tous les objets en même temps.
Vous pouvez également utiliser le menu contextuel pour sélectionner l’un des objets 
qui se chevauchent afin de l’éditer directement. Il s’agit de l’une des méthodes à votre 
disposition pour manipuler individuellement des objets au sein d’un groupe, sans avoir 
à développer ce groupe.
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Pour modifier un seul élément situé dans une zone de chevauchement au sein 
d’un groupe :
1 Cliquez sur la zone de chevauchement du groupe tout en maintenant la touche 
Contrôle enfoncée, puis choisissez l’objet à manipuler dans le menu contextuel.
Les limites de cet objet sont mises en surbrillance dans la piste du groupe.
2 Déplacez, appliquez un Trim ou coulissez l’objet indépendamment des autres objets 
du groupe.
Application d’un Trim sur des objets dans la piste du groupe
Effectuer un Trim sur les bords de la piste d’un groupe permet d’effectuer automatiquement un Trim sur les bords de tous les objets qu’il contient. S’il ne contient qu’un seul 
objet, le fait d’effectuer un Trim sur la barre du groupe permet seulement d’effectuer 
un Trim sur cet objet. En revanche, si plusieurs objets sont alignés sur le bord du groupe, 
le Trim appliqué au groupe provoque le Trim automatique de tous ces objets.
Vous ne pouvez pas effectuer un Trim sur des pistes d’objets particulières au sein 
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Déconnexion de la piste du groupe de son contenu
Vous pouvez modifier la barre d’un groupe, de telle sorte qu’elle soit plus longue 
ou plus courte que le contenu du groupe correspondant. Vous pouvez par exemple 
raccourcir la barre d’un groupe, afin de masquer une partie des objets qu’il contient. 
Les objets situés au-delà des limites de la barre du groupe (la barre bleue étroite en 
haut de la piste du groupe) ne sont pas affichés dans le Canevas.
Pour modifier la longueur d’un groupe indépendamment des objets qu’il contient :
m Appuyez sur la touche Commande, puis faites glisser le bord de la piste du groupe.
Seule la fine barre de couche bleue est affectée par le Trim.
Remarque : une fois la longueur de la barre du groupe modifiée manuellement, 
elle n’est plus automatiquement mise à jour au fur et à mesure que vous y ajoutez 
des objets ou en modifiez. Pour rétablir la mise à jour automatique, alignez de nouveau 
la barre du groupe avec le bord droit du dernier plan du groupe.
Vous pouvez utiliser cette technique pour effectuer un Trim sur un objet sans modifier 
automatiquement la durée des masques, filtres ou autres effets appliqués.
Pour effectuer un Trim sur un objet sans modifier les effets appliqués :
m Appuyez sur la touche Commande tout en faisant glisser le bord de l’objet.
Avant AprèsChapitre 4 Utilisation de la Timeline 391
Coulissement d’objets dans la piste d’un groupe
En plus des options de déplacement et de Trim, vous pouvez faire coulisser certains 
objets directement dans la barre d’un groupe. En effet, toute portion d’un groupe 
ne contenant qu’un seul objet peut faire l’objet d’une telle opération. Cependant, 
il est impossible de faire coulisser des zones où plusieurs objets se chevauchent sans 
développer le groupe et manipuler directement les objets proprement dits.
Pour faire coulisser un objet dans la piste d’un groupe :
1 Tout en maintenant la touche Option enfoncée, cliquez sur la zone du groupe incluant 
l’objet.
2 Faites-la glisser vers la droite ou vers la gauche afin d’utiliser une partie ultérieure 
ou antérieure des médias sans modifier la position ou la durée de l’objet.
Vous ne pouvez faire coulisser un objet que si les médias sources associées à ce plan 
contiennent suffisamment d’images inutilisées. Pour en savoir plus sur le coulissement, 
voir « Coulissement de plans » à la page 378.
Utilisation de la réglette
Vous pouvez vous servir de la réglette de la Timeline afin d’effectuer plusieurs types de 
fonctions. Vous pouvez placer la tête de lecture sur une image spécifique afin de visionner 
le projet à un moment précis. Vous pouvez également définir des points d’entrée et de 
sortie afin que la lecture ne soit effectuée qu’entre les images spécifiées. Il est possible 
également de sélectionner une plage d’images afin de pouvoir supprimer, couper 
ou coller dans les images sélectionnées.
Navigation dans la Timeline
Motion propose différents contrôles pour naviguer dans la Timeline. Vous pouvez faire 
glisser directement la tête de lecture afin de « défiler » à travers votre projet aussi 
vite ou lentement que vous le souhaitez ou vous rendre sur une image spécifique. 
Vous pouvez également « sauter » automatiquement sur les limites d’objet, les marqueurs 
et d’autres indicateurs importants dans la Timeline.
Point d’entrée Point de sortie
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Pour déplacer la tête de lecture dans le temps, procédez de l’une des manières 
suivantes :
m Cliquez deux fois sur le champ Sur l’image actuelle, saisissez un numéro d’image, 
puis appuyez sur Retour.
m Faites glisser le curseur de valeur Sur l’image actuelle vers la gauche ou vers la droite 
pour reculer ou avancer.
m Faites glisser la tête de lecture sur l’image souhaitée.
m Cliquez dans la réglette sur le numéro d’image correspondant à l’endroit où vous 
souhaitez placer la tête de lecture.
m Le Canevas ou la sous-fenêtre Projet étant actif, tapez le numéro de timecode 
ou le numéro d’image vers lequel vous souhaitez déplacer la tête de lecture. Le 
nouveau numéro d’image apparaît dans le champ Sur l’image actuelle dans le Canevas. 
Appuyez sur Retour afin de passer à cette image.
m La Timeline étant active, tapez le numéro de timecode ou d’image vers lequel vous 
souhaitez déplacer la tête de lecture. Le nouveau numéro d’image apparaît dans le champ 
Sur l’image actuelle dans la Timeline. Appuyez sur Retour afin de passer à cette image.
Pour avancer d’un nombre spécifique d’images :
m Saisissez le signe plus (+) suivi du nombre d’images dont vous souhaitez avancer.
Pour reculer d’un nombre spécifique d’images :
m Saisissez le signe moins (–) suivi du nombre d’images dont vous souhaitez reculer.
Pour avancer ou reculer d’un certain nombre de secondes, minutes ou heures, 
tapez ce qui suit dans le champ Image actuelle :
m Pour avancer d’un certain nombre de secondes, saisissez le signe plus (+) suivi 
du nombre de secondes dont vous souhaitez avancer, puis un point. Par exemple, 
pour avancer de 2 secondes, entrez +2. dans le champ, puis appuyez sur Retour. 
Pour avancer de minutes, tapez deux points après le nombre, et pour avancer 
d’heures, tapez trois points après le nombre.
m Pour reculer d’un certain nombre de secondes, saisissez le signe moins (–) suivi 
du nombre de secondes dont vous souhaitez reculer, puis un point. Par exemple, 
pour reculer de 2 secondes, entrez –2. dans le champ, puis appuyez sur Retour. 
Pour reculer de minutes, tapez deux points après le nombre, et pour reculer 
d’heures, tapez trois points après le nombre.
Pour lire votre projet :
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Pour avancer ou reculer d’une image à la fois, procédez de l’une des manières 
suivantes :
m Cliquez sur le bouton « Avancer d’une image » ou « Reculer d’une image » situé parmi 
les commandes de lecture (à gauche du bouton Lire/désactiver l’audio).
m Choisissez Marquer > Aller à > Image précédente ou Image suivante.
m Appuyez sur la touche Flèche gauche pour reculer et sur Flèche droite pour avancer.
Pour avancer ou reculer de dix images à la fois, procédez de l’une des manières 
suivantes :
m Choisissez Marquer > Aller à > 10 images en arrière ou 10 images en avant.
m Appuyez sur la touche Maj, puis sur Flèche gauche ou Flèche droite.
Pour accéder directement au début du projet, procédez de l’une des manières 
suivantes :
m Cliquez sur le bouton « Aller au début du projet » situé parmi les commandes 
de lecture (à droite du bouton Enregistrer).
m Choisissez Marquer > Aller à > Début du projet.
m Appuyez sur la touche Début.
Pour accéder directement à la fin de votre projet, procédez de l’une des manières 
suivantes :
m Cliquez sur le bouton « Aller à la fin du projet » dans les commandes de lecture.
m Choisissez Marquer > Aller à > Fin du projet.
m Appuyez sur la touche Fin.
Pour passer à l’image clé suivante, effectuez l’une des opérations suivantes :
m Sélectionnez un objet animé, puis appuyez simultanément sur les touches Maj + K.
m Choisissez Marquer > Aller à > Image clé suivante.
Pour passer à l’image clé précédente, effectuez l’une des opérations suivantes :
m Sélectionnez un objet animé, puis appuyez simultanément sur les touches Option + K.
m Choisissez Marquer > Aller à > Image clé précédente.
Pour en savoir plus sur l’affichage d’images clés dans la Timeline, voir « Options de 
présentation de la Timeline » à la page 360.
Outre le simple déplacement vers de nouvelles positions sur la réglette, vous pouvez 
naviguer directement jusqu’aux éléments de la Timeline, tels que les objets, les marqueurs 
et les images clés. Pour en savoir plus sur les marqueurs, consultez la rubrique « Ajout 
de marqueurs » à la page 398. Pour en savoir plus sur les images clés, consultez la rubrique « Images et clés et courbes » à la page 547.394 Chapitre 4 Utilisation de la Timeline
Pour accéder directement au début ou à la fin d’un objet dans la Timeline :
1 Sélectionnez l’objet auquel vous souhaitez accéder.
2 Procédez de l’une des manières suivantes :
Â Choisissez Marquer > Aller à > « Point d’entrée de la sélection » ou « Point de sortie 
de la sélection ».
Â Appuyez sur les touches Maj + I (pour le point d’entrée) ou Maj + O (pour le point 
de sortie). 
Définition de la plage de lecture
L’activation du bouton de lecture permet généralement de lire votre projet de la première 
image à la dernière. Vous pouvez néanmoins choisir la portion de projet lue par Motion 
en modifiant les points d’entrée et de sortie dans la réglette de la Timeline. Cette manière 
de procéder peut s’avérer utile pour concentrer l’attention sur une portion particulière lors 
du perfectionnement de votre projet ou lorsque vous apportez d’autres modifications. 
Après avoir porté votre attention sur une portion particulière de votre projet, vous pouvez 
rétablir les points d’entrée et de sortie au début et à la fin du projet.
Pour personnaliser le point d’entrée de la lecture, procédez de l’une des manières 
suivantes :
m Sur la réglette, faites glisser le marqueur de point d’entrée depuis le bord gauche de 
la réglette jusque sur l’image où vous souhaitez définir le point d’entrée. La tête de 
lecture se déplace en même temps que le pointeur que vous faites glisser. Dès que 
vous relâchez le bouton de la souris, la tête de lecture revient à sa position antérieure.
m Choisissez Marquer > Marquer le point d’entrée de la plage de lecture.
m Appuyez simultanément sur les touches Commande + Option + I.
Pour personnaliser le point de sortie de la lecture, procédez de l’une des manières 
suivantes :
m Sur la réglette, faites glisser le marqueur de point de sortie depuis le bord droit 
de la réglette jusque sur l’image où vous souhaitez définir le point de sortie. 
m Choisissez Marquer > Marquer le point de sortie de la plage de lecture.
m Appuyez simultanément sur les touches Commande + Option + O.
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Pour réinitialiser les points d’entrée et de sortie de la plage de lecture, procédez 
de l’une des manières suivantes :
m Choisissez Marquer > Réinitialiser la plage de lecture.
m Appuyez simultanément sur les touches + X. 
Les points d’entrée et de sortie sont placés automatiquement au début et à la fin 
du projet.
Pour naviguer jusqu’au points d’entrée et de sortie de la lecture, procédez de 
l’une des manières suivantes :
m Choisissez Marquer > Aller à > « Début de la plage de lecture » ou « Fin de la plage 
de lecture ».
m Appuyez sur les touches Maj + Début (point d’entrée) ou Maj + Fin (point de sortie).
Utilisations des régions
Il peut arriver que vous soyez amené à apporter des modifications à une plage d’images, 
encore appelée une région. Cela peut servir par exemple à couper ou copier une portion 
de temps afin de la supprimer ou de la déplacer vers une nouvelle position dans votre 
projet. Les régions ne doivent pas nécessairement être alignées sur les bords des objets 
dans la Timeline. Vous pouvez créer une région qui débute au milieu d’un objet ou qui 
inclut des images vides au-delà des bords des objets. 
Pour sélectionner une plage d’images :
m Maintenez enfoncées les touches Commande + Option, puis glissez sur les images 
à sélectionner dans la Timeline.
Une bande bleu clair apparaît sur les images sélectionnées.396 Chapitre 4 Utilisation de la Timeline
Pour développer ou réduire une région :
m Positionnez le pointeur sur chaque bord d’une région afin de modifier son point de fin. 
Cliquez vers la droite pour rallonger la région ou vers la gauche pour la raccourcir. 
Les régions sélectionnées s’appliquent généralement à toutes les pistes de votre Timeline. 
Toutefois, il peut arriver que vous ne souhaitiez sélectionner qu’une ou plusieurs pistes. 
Cela vous permet de réaliser des sélections complexes à travers plusieurs couches 
et pistes.
Pour déplacer une région :
m Positionnez le pointeur sur la région, puis faites glisser afin de déplacer la région.
Pour désélectionner des pistes dans une plage de sélection :
m Cliquez sur la piste à désélectionner en maintenant la touche Commande enfoncée.
Après avoir défini votre plage de sélection, vous pouvez supprimer la section ou effectuer 
une suppression Ripple sur la section (pour la supprimer et boucher le vide). Vous pouvez 
couper ou copier la section pour la placer dans le Presse-papiers afin de la coller ailleurs.
Remarque : le collage d’une région ne s’effectue pas à l’emplacement actuel de la tête 
de lecture. Pour déplacer rapidement la région collée vers l’emplacement de la tête 
de lecture, appuyez sur la touche Maj tout en faisant glisser l’objet collé. À mesure que 
vous approchez de la position actuelle de la tête de lecture, l’objet se magnétise.
Vous pouvez également effectuer un collage spécial dans une région, ce qui permet 
de remplir la région existante avec le contenu du Presse-papiers.Chapitre 4 Utilisation de la Timeline 397
Collage dans
Les régions s’avèrent également utiles pour effectuer un type spécial de commande 
de collage appelé Coller dans. Vous pouvez définir une région et y coller des objets. 
Le collage spécial propose trois modes d’exécution. Vous pouvez procéder par insertion, 
en repoussant la région dans le temps ; par écrasement du contenu de la région ; ou en 
échangeant les objets avec le contenu du Presse-papiers. Quel que soit votre choix, 
les objets collés n’excèdent jamais la durée de la région dans laquelle ils sont collés.
Pour coller dans une région :
1 Sélectionnez l’objet à copier dans le Presse-papiers afin de le coller.
2 Appuyez simultanément sur les touches Commande + C ou Commande + X pour 
copier ou couper votre sélection.
3 Faites glisser le pointeur tout en maintenant les touches Commande + Option enfoncées 
pour sélectionner une région de la Timeline.
4 Choisissez Édition > Collage spécial. 
La zone de dialogue Collage spécial apparaît.
5 Sélectionnez Insérer, Écraser ou Échanger.
6 Cliquez sur OK pour fermer la zone de dialogue.
Le contenu du Presse-papiers est collé dans la région via la méthode que vous avez 
choisie. Pour plus d’informations sur les différents types de montage, voir « Ajout 
d’objets dans la Timeline » à la page 363.
Insertion de temps
Vous pouvez sélectionner une région afin d’insérer un blanc dans votre projet. 
Vous pouvez par exemple ajouter quelques images noires entre deux objets ou placer 
quelques images destinées à signaler l’emplacement d’un plan que vous ne possédez 
pas encore. Ce procédé est appelé insertion de temps.
Pour insérer du temps dans un projet :
1 Maintenez enfoncées les touches Commande + Option, puis faites glisser le réglette. 
Sélectionnez une zone aussi large que ce que vous souhaitez insérer.
2 Choisissez Édition > Insérer une zone de temps.398 Chapitre 4 Utilisation de la Timeline
Le nombre d’images de la zone est ajouté au projet, en commençant à la fin de 
la région sélectionnée et en repoussant tout objet plus loin dans le temps.
Durée du projet
Les projets Motion ont par défaut une durée de dix secondes. Vous pouvez modifier 
cette durée en fonction des besoins de votre projet. Pour apprendre comment modifier 
la durée par défaut du projet, voir « Onglet Générales de la zone de dialogue Propriétés 
du projet » à la page 202. 
Pour modifier la durée du projet, procédez de l’une des manières suivantes :
m Faites glisser le champ Durée du projet situé dans l’angle inférieur droit du Canevas. 
Un glissement vers la droite rallonge la durée et un glissement vers la gauche la raccourcit.
m Cliquez sur le champ Durée du pro jet et saisissez un nombre dans le champ.
m Choisissez Édition > Propriétés du projet (ou appuyez sur les touches Commande + J), 
puis modifiez la valeur du champ Durée du projet dans la zone de dialogue.
Remarque : vous pouvez cliquer sur le bouton du chronomètre pour permuter entre 
l’affichage du champ Durée du projet en images ou en timecode.
Ajout de marqueurs
Un marqueur est un point de référence visuel dans la Timeline qui permet d’identifier 
une image particulière. Vous pouvez ajouter autant de marqueurs que vous le souhaitez 
dans la réglette de la Timeline, pendant la lecture du projet ou lorsque la tête de lecture 
est arrêtée. 
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Utilisez des marqueurs pour : 
Â Ajouter une référence visuelle à une piste.
Â Ajouter une référence visuelle à un marqueur de projet dans la mini-Timeline
Â Aligner des pistes, des objets ou des images clés sur un point important dans le temps.
Â Ajouter des notes concernant une partie précise de votre projet.
Vous pouvez affecter des couleurs différentes à différents types de marqueurs et créer 
des groupes de marqueurs. Utilisez par exemple le vert pour identifier tous les marqueurs 
audio ou le jaune pour identifier tous les marqueurs d’objet temporaires.
Vous pouvez ajouter deux types de marqueurs : les marqueurs de projet et les marqueurs 
d’objet. Les marqueurs de projet sont fixés sur une valeur de timecode spécifique dans 
la réglette. Quant aux marqueurs d’objet, ils sont associés à un objet et se déplacent 
au fur et à mesure des déplacements de l’objet correspondant. Les marqueurs d’objet 
apparaissent uniquement dans la Timeline. Les marqueurs de projet sont affichés dans 
la Timeline, l’Éditeur d’images clés et l’Éditeur audio.
Remarque : les marqueurs de projet sont indiqués dans la mini-Timeline par une fine 
ligne verte. Pour en savoir plus sur l’utilisation de la mini-Timeline, voir « Mini-Timeline » 
à la page 68.
Marqueur d’objet
Marqueur de projet
Marqueur d’objet
Marqueur de projet Marqueur de projetPour ajouter un marqueur de projet :
1 Placez la tête de lecture sur l’image exacte correspondant à l’endroit où vous souhaitez 
placer le marqueur.
2 Assurez-vous qu’aucun objet n’est sélectionné, puis procédez de l’une des manières 
suivantes :
Â Choisissez Marquer > Marqueurs > Ajouter un marqueur.
Â Appuyez sur la touche M. 
Â Cliquez sur la barre grise du marqueur située au-dessus de la réglette de la Timeline 
tout en maintenant la touche Contrôle enfoncée, puis choisissez Ajouter un marqueur 
dans le menu contextuel.
Un marqueur vert est ajouté à la barre grise située au-dessus de la réglette de la Timeline.
Remarque : vous pouvez également appuyer sur les touches Maj + M pour ajouter un 
marqueur de projet à la position de la tête de lecture, qu’un objet soit sélectionné ou non.
Pour ajouter un marqueur d’objet :
1 Placez la tête de lecture sur l’image exacte correspondant à l’endroit où vous souhaitez 
placer le marqueur.
2 Sélectionnez l’objet sur lequel vous souhaitez ajouter le marqueur, puis procédez 
de l’une des manières suivantes :
Â Choisissez Édition > Marqueurs > Ajouter un marqueur.
Â Appuyez sur la touche M. 
Un marqueur rouge est ajouté à la barre du groupe. 
Vous pouvez, de cette manière, ajouter des marqueurs pendant la lecture de votre projet. 
Les marqueurs apparaissent sur l’image où se trouvait la tête de lecture au moment 
où vous avez appuyé sur la touche M.
Pour déplacer un marqueur :
m Faites glisser le marqueur à gauche ou à droite vers un nouvel emplacement.Chapitre 4 Utilisation de la Timeline 401
Pour supprimer un marqueur, procédez de l’une des manières suivantes :
m Faites glisser le marqueur verticalement hors de la zone où il se trouve, puis relâchez 
le bouton de la souris.
La disparition du marqueur est signalée par le son « pouf ». 
m Double-cliquez sur le marqueur, puis cliquez sur le bouton Supprimer dans la zone 
de dialogue Modifier le marqueur.
m Placez la tête de lecture sur le marqueur, sélectionnez le groupe ou l’objet (pour les 
marqueurs de groupe ou d’objet), puis choisissez Marquer > Marqueurs > Supprimer.
m Cliquez sur le marqueur en maintenant la touche Contrôle enfoncée, puis choisissez 
Supprimer le marqueur dans le menu contextuel.
Suppression de tous les marqueurs
Vous pouvez supprimer non seulement un marqueur individuel, mais également tous 
les marqueurs de votre projet simultanément. Cela permet de supprimer les marqueurs 
de projet ou tous les marqueurs d’une couche ou d’un objet déterminé.
Pour supprimer uniquement tous les marqueurs de projet :
1 Choisissez Édition > Tout désélectionner (ou appuyez sur les touches Commande + 
Maj + A).
2 Choisissez Marquer > Marqueurs > Supprimer tous les marqueurs.
Pour supprimer tous les marqueurs d’objet, procédez de l’une des manières 
suivantes :
m Sélectionnez le groupe ou la couche contenant les marqueurs à supprimer, 
puis choisissez Marquer > Marqueurs > Supprimer tous les marqueurs.
m Cliquez sur la barre grise du marqueur située au-dessus de la réglette de la Timeline 
tout en maintenant la touche Contrôle enfoncée, puis choisissez Supprimer tous 
les marqueurs dans le menu contextuel.
Modification des informations sur les marqueurs
Vous pouvez modifier les informations d’un marqueur (le nom, l’image de départ, 
la durée et la couleur). Vous pouvez également ajouter des commentaires au marqueur. 
Les commentaires sont affichés sous la forme d’une bulle d’aide lorsque le pointeur 
s’arrête sur le marqueur.402 Chapitre 4 Utilisation de la Timeline
Pour modifier les informations d’un marqueur :
1 Ouvrez la zone de dialogue Modifier le marqueur en effectuant l’une des opérations 
suivantes :
Â Double-cliquez sur un marqueur afin d’afficher la zone de dialogue Modifier le marqueur.
Â Choisissez Édition > Marqueurs > Modifier.
Â Cliquez sur le marqueur en maintenant la touche Contrôle enfoncée, puis choisissez 
Modifier les marqueurs dans le menu contextuel.
Les notes ajoutées au champ Commentaire apparaissent sous forme de bulle d’aide 
lorsque le pointeur se trouve sur le marqueur.
2 Saisissez un nom dans le champ Nom.
3 Saisissez un nombre dans le champ Début. 
Le marqueur est placé sur l’image correspondant à la valeur saisie.
4 Saisissez une valeur dans le champ Durée pour spécifier la plage d’images pour 
le marqueur.
5 Saisissez vos annotations dans le champ Commentaire. 
Ce commentaire apparaît sous la forme d’une bulle d’aide lorsque vous arrêtez 
le pointeur sur des marqueurs de projet.
6 Cliquez sur le menu local des couleurs pour afficher la liste des huit couleurs proposées, 
puis choisissez une couleur pour le marqueur.Chapitre 4 Utilisation de la Timeline 403
7 Cliquez sur le menu local Type pour choisir le type de marqueur :
Â Standard : marqueur par défaut utilisé dans Motion.
Â Boucle du menu DVD : lors de l’utilisation d’un projet Motion comme arrière-plan 
de menu dans DVD Studio Pro, le menu DVD lit normalement l’intégralité du projet 
Motion, puis redémarre la lecture au début du projet. Si un marqueur est défini au 
niveau du point de départ de la boucle, le menu DVD lit une première fois le projet 
Motion jusqu’à la fin, puis redémarre la lecture au niveau du marqueur de ce point 
lors des boucles suivantes.
Â Transition DVD Alpha : lors de l’utilisation d’un projet Motion comme transition alpha 
dans DVD Studio Pro, ce marqueur détermine le point où la valeur alpha de la transition 
(le projet Motion) dévient égale à 0. Si un projet Motion sert de transition, seul son canal 
alpha est utilisé lors de la fusion de deux éléments vidéo dans DVD Studio Pro.
8 Cliquez sur OK pour confirmer vos modifications.
Navigation à l’aide des marqueurs
Vous pouvez passer directement de la position actuelle de la tête de lecture à 
un marqueur de projet voisin situé devant ou derrière.
Pour accéder directement au marqueur suivant :
m Cliquez en maintenant la touche Contrôle enfoncée, sur la barre de marqueur grise 
située au-dessus de la réglette de la Timeline, puis choisissez Marqueur suivant dans 
le menu contextuel. 
La tête de lecture se place automatiquement sur la position du marqueur de projet suivant.
Vous pouvez également choisir Marquer > Aller à > Marqueur suivant ou appuyer 
sur les touches Commande + Option + Flèche droite.
Pour accéder directement au marqueur précédent :
m Tout en maintenant la touche Contrôle enfoncée, cliquez sur la barre de marqueur grise 
située au-dessus de la réglette de la Timeline, puis choisissez Précédent suivant dans 
le menu contextuel.
La tête de lecture se place automatiquement sur la position du marqueur de projet 
précédent.
Vous pouvez également choisir Marquer > Aller à > Marqueur précédent ou appuyer 
sur les touches Commande + Option + Flèche gauche.
Par ailleurs, la zone de dialogue Modifier le marqueur vous permet d’accéder à des 
marqueurs adjacents. Dans ce cas, la zone de dialogue reste ouverte et son contenu 
est remplacé par les informations correspondant au marqueur suivant.
Marqueur suivant
Marqueur précédent5
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5 Utilisation des comportements
Les comportements vous permettent d’animer des objets 
grâce à de simples commandes graphiques. Vous pouvez ainsi 
facilement créer des effets d’animation de base ou simuler 
des interactions complexes entre plusieurs objets.
Il vous suffit donc d’ajouter des comportements à des objets (caméras, lumières, 
couches ou groupes) ou des propriétés au sein d’un projet pour créer des effets animés sans recourir à la création ou à l’ajustement d’images clés. Pour ce faire, faites glisser un comportement sur un objet, afin de l’animer automatiquement selon le type de 
comportement appliqué. Pour changer l’impact d’un comportement, vous pouvez 
en personnaliser les paramètres dans la palette ou dans l’onglet Comportements de 
l’Inspecteur.
Les comportements sont d’une grande flexibilité et s’associent aisément les uns aux 
autres afin de générer toutes sortes d’effets. Grâce à eux, la conception d’animations 
devient interactive, ce qui vous permet de créer rapidement des effets d’animation 
élaborés et de simuler des interactions entre les objets.
Ils peuvent également servir à animer les paramètres de quasiment tous les émetteurs 
de particules, formes, masques, réplicateurs, filtres, générateurs, caméras ou lumières. 
Vous pouvez ainsi créer rapidement des arrière-plans animés, des effets de filtres 
dynamiques, des effets de caméra ou de lumière intéressants, ainsi que des systèmes 
de particules extrêmement complexes, simplement à l’aide de quelques commandes.
Les comportements Suivi de l’animation ont un objectif très différent des autres comportements. Au lieu d’animer immédiatement l’objet auquel ils sont appliqués, ils analysent le mouvement de cet objet ou d’un plan. Une fois analysé, ce mouvement peut 
servir à stabiliser un plan un peu chaotique, à faire correspondre le mouvement d’un 
objet au mouvement du plan analysé, à suivre une couche sur un plan (comme un logo 
ou un texte sur une voiture en mouvement), etc. Pour en savoir plus sur l’utilisation des 
comportements Suivi de l’animation, voir « Suivi de l’animation » dans le manuel PDF
Documentation Supplémentaire de Motion.406 Chapitre 5 Utilisation des comportements
Il existe 11 types de comportements dans Motion.
Â Les comportements Audio sont appliqués aux fichiers audio afin de créer des effets 
sonores simples, tels que des fondus entrants et sortants, des balances et des survols. 
Il existe également un comportement de paramètre Audio distinct que vous pouvez 
appliquer aux paramètres de la quasi-totalité des objets. Pour en savoir plus sur 
les comportements Audio, voir « Comportements Audio » à la page 1226.
Â Les comportements Animation standard sont les plus simples. Ils animent des paramè-
tres spécifiques de l’objet auquel ils sont appliqués. Certains ont une incidence 
sur la position, d’autres sur l’échelle ou la rotation. Il s’agit par exemple de Fondu 
entrant/sortant, Rotation et Lancer. Tous ces comportements s’appliquent aux images, aux plans, aux émetteurs de particules, aux formes, au texte, etc. La majeure 
partie de ces comportements peut être appliquée aux caméras et aux lumières.
Â Les comportements Caméra sont spécialement conçus pour être appliqués à une caméra 
et lui imposer des mouvements de base dans un projet 3D, tels que des travellings, 
des panoramiques et des zooms. Pour en savoir plus sur l’utilisation des comportements 
Caméra, voir « compositing 3D » dans le manuel Motion Supplemental Documentation
PDF.
Â Les comportements Suivi de l’animation exécutent plusieurs tâches. Bien que tous 
les comportements de suivi analysent l’animation présente dans un plan, l’application des données correspondantes varie en fonction du comportement spécifique 
appliqué. Par exemple, le comportement Stabiliser permet de stabiliser le mouvement éventuellement provoqué par une caméra instable dans un plan. Quant au 
comportement Suivre le mouvement, il analyse le mouvement d’un objet (un plan, 
par exemple), puis l’applique à un autre objet pour l’intégrer à la source du suivi. 
Pour en savoir plus sur l’utilisation des comportements Suivi de l’animation, voir 
« Suivi de l’animation » dans le manuel PDF Documentation Supplémentaire de Motion.
Â Les comportements Paramètre sont applicables aux paramètres de n’importe quel objet 
(y compris les filtres et les comportements). Leurs effets se limitent au paramètre 
sélectionné. Il est possible d’ajouter le même comportement Paramètre à différents 
paramètres, ce qui donne des effets totalement distincts. Par exemple, vous pouvez 
appliquer le comportement Osciller à l’opacité d’un texte pour le doter d’un fondu 
entrant et sortant ou à la rotation d’une forme pour la faire pivoter dans un sens 
et dans l’autre. Il est également possible d’appliquer certains de ces comportements 
à des paramètres de filtres, de générateurs, de systèmes de particules et de réplicateurs, 
voire à d’autres comportements. Il s’agit par exemple de Osciller, Rendre aléatoire et 
Inverser. La majeure partie de ces comportements peut être appliquée aux caméras 
et aux lumières.
Â Les comportements Particules sont spécifiquement conçus pour s’appliquer aux 
émetteurs de particules ou aux cellules qu’ils contiennent. Ils ont une incidence 
sur le mode d’animation de particules individuelles au cours de leur durée de vie. 
Pour en savoir plus sur l’utilisation des comportements de particules, voir « Utilisation 
des comportements Particules » à la page 801.Chapitre 5 Utilisation des comportements 407
Â Les comportements Réplicateur sont spécifiquement conçus pour s’appliquer aux 
réplicateurs ou aux cellules qu’ils contiennent. Ces comportements ont une incidence 
sur la façon dont les paramètres des cellules du réplicateur sont animées sur leur 
motif. Par exemple, vous pouvez créer une animation qui se déplace sur le motif 
du réplicateur, dans lequel chaque cellule va d’une opacité de 0 % à une opacité 
de 100 %. Pour en savoir plus sur l’utilisation des comportements Réplicateur, 
voir « Utilisation du comportement Réplicateur de séquence » à la page 888.
Â Les comportements Resynchronisation s’appliquent directement à une séquence et 
à des couches clonées (ou à des groupes) afin de créer des images fixes, d’inverser 
la séquence, de modifier sa vitesse, de créer des images stroboscopiques ou instables, 
ou de faire défiler la séquence. Ils sont appliqués aux objets de la séquence répertoriés 
dans la liste de couches, et non via l’onglet Média. Pour en savoir plus sur l’utilisation 
des comportements Resynchronisation, voir « Comportements Resynchronisation » à 
la page 495.
Â Les comportements Forme sont spécifiquement conçus pour s’appliquer à une forme 
ou à un masque. Ils affectent les différents vertex d’une forme ou d’un masque. 
Par exemple, l’application du comportement Rendre aléatoire anime de façon aléatoire 
les points de contrôle (ou les tangentes, voire les deux) d’une forme. Pour en savoir 
plus sur l’utilisation des comportements Forme, voir « Utilisation des comportements 
Forme » à la page 1147.
Â Les comportements Simulation réalisent deux types de tâches. Certains, tels que 
Gravité, animent les paramètres d’un objet de façon à simuler un phénomène réel. 
D’autres, tels qu’Attracteur et Repousser, ont une incidence sur les paramètres d’un 
ou plusieurs objets situés autour de l’objet auquel ils sont appliqués. Ces comportements vous permettent de créer des interactions très élaborées entre plusieurs objets 
d’un projet et ce, avec un minimum de réglages. Tout comme les comportements 
Animation standard, les comportements Simulation affectent des paramètres particuliers 
des objets. Il s’agit par exemple d’Attracteur, Gravité et Repousser. Tous les comportements Simulation peuvent être appliqués aux caméras et aux lumières.
Â Les comportements Texte animent les paramètres des textes afin de créer divers effets 
animés. Il s’agit par exemple de Défilement vers le haut qui fait défiler des titres ou un 
générique verticalement et de Machine à écrire qui affiche un texte lettre par lettre. Pour 
en savoir plus sur la manière d’utiliser les comportements Texte, voir « Comportements 
Animation de texte » à la page 703 et « Comportements Séquence de texte » à la 
page 725.
Pour découvrir comment utiliser des comportements, voir « Application et suppression 
de comportements » à la page 410. Pour en savoir plus sur l’application des comportements, voir « Application et suppression de comportements » à la page 413. Pour plus 
de détails sur la manipulation de comportements dans un projet, voir « Utilisation des 
comportements » à la page 425. Pour plus de détails sur tous les comportements disponibles dans Motion, voir « Descriptions de comportements » à la page 446.408 Chapitre 5 Utilisation des comportements
Remarque : un chapitre séparé est consacré aux comportements Audio, Suivi de 
l’animation, Forme, Particules, Réplicateur et Caméra. 
Pour des exemples détaillés sur l’utilisation des comportements, voir « Exemples de 
comportements » à la page 528.
Comparaison entre les comportements et les images clés
Il est important de bien comprendre que les comportements n’ajoutent pas d’images 
clés aux objets ou aux paramètres auxquels ils sont appliqués. En fait, ils génèrent 
automatiquement une plage de valeurs, lesquelles sont appliquées aux paramètres 
d’un objet, afin d’animer ce dernier sur toute la durée du comportement. La modification des paramètres d’un comportement altère la plage de valeurs que celui-ci génère.
Pour leur part, les images clés appliquent des valeurs déterminées directement à 
un paramètre. Lorsque vous créez plusieurs images clés avec des valeurs différentes, 
vous animez un paramètre de la première valeur d’image clé à la dernière.
Les comportements s’avèrent en soi plus utiles pour créer des effets d’animation 
continus et génériques. Ils sont également très commodes pour créer des effets animés 
éventuellement trop complexes pour une animation manuelle avec des images clés. 
À l’inverse, l’animation avec des images clés révèle tout son intérêt pour créer des effets 
animés déterminés, là où le paramètre que vous réglez doit atteindre une valeur 
spécifique à un moment donné. Pour en savoir plus sur l’utilisation des images clés, 
voir « Images et clés et courbes » à la page 547. 
Il est possible de convertir en images clés une animation créée par des comportements. 
Pour en savoir plus, voir « Conversion de comportements en images clés » à la 
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Recherche de comportements
Tous les comportements disponibles figurent dans l’onglet Bibliothèque. Sélectionnez 
la catégorie Comportements dans la fenêtre correspondante de la barre latérale pour 
afficher les sous-catégories de comportements (les comportements Texte correspondent 
à deux catégories). Sélectionnez ensuite une sous-catégorie pour afficher tous les comportements de ce type dans la pile de la Bibliothèque.
Si vous sélectionnez un comportement dans la pile de la Bibliothèque, une brève 
description et un aperçu apparaissent dans la zone de Preview.
Comportements dans la sous-catégorie sélectionnée
Sous-catégories 
de comportements Catégories de
la Bibliothèque410 Chapitre 5 Utilisation des comportements
Remarque : pour vous aider à comprendre le fonctionnement des comportements, 
vous pouvez consulter des aperçus animés, qui se présentent sous la forme de trajectoires 
d’animation et de codes de couleur. La plupart des aperçus sont explicites. Toutefois, 
dans le cas des comportements Paramètre, les aperçus montrent des exemples avant/
après de l’effet de ces comportements sur un objet animé (la roue dentée passe au rouge 
pour signaler l’objet après l’application des comportements). En ce qui concerne les 
comportements Simulation, la roue dentée rouge indique à quel objet d’un groupe 
le comportement sélectionné est appliqué.
Application et suppression de comportements
Pour appliquer directement des comportements à des objets, procédez de l’une 
des manières suivantes :
Â Faites glisser un comportement directement sur un objet dans le Canevas, 
l’onglet Couches ou la Timeline.
Pour appliquer un comportement à un objet dans la Timeline, faites glisser ce 
comportement sur l’objet concerné dans la liste de couches ou la zone de pistes 
de la Timeline.
Remarque : en règle générale, il est plus facile de faire glisser un comportement 
sur une caméra ou une lumière dans l’onglet Couches ou la Timeline, plutôt que 
de procéder directement dans le Canevas.
Â Sélectionnez un objet, choisissez un comportement dans la Bibliothèque, puis cliquez 
sur le bouton Appliquer dans la zone de Preview de l’Inspecteur. 
Â Sélectionnez un objet, puis choisissez un comportement en cliquant sur le bouton 
Ajouter comportement de la barre d’outils.
Â Cliquez sur un paramètre d’un objet tout en maintenant la touche Contrôle enfoncée 
(même un paramètre d’autres comportements), puis choisissez un comportement 
Paramètre dans le menu contextuel.
Pour supprimer un comportement, sélectionnez-le dans le Canevas, l’onglet Couches, 
la Timeline ou l’Inspecteur, puis appuyez sur la touche Supprimer.Chapitre 5 Utilisation des comportements 411
Emplacement des comportements
Lorsque vous appliquez un comportement à un objet, il apparaît imbriqué en dessous 
de cet objet dans l’onglet Couches et la Timeline.
Les comportements récemment appliqués à un objet apparaissent au-dessus 
des précédents.
Comportements imbriqués tels qu’ils apparaissent dans l’onglet Couches
Comportements imbriqués tels qu’ils apparaissent dans la Timeline
Un nouveau comportement se 
place au-dessus de ceux appliqués 
auparavant. Les comportements 
apparaissent avec tous leurs paramètres modifiables dans l’onglet 
Comportements de l’Inspecteur.412 Chapitre 5 Utilisation des comportements
Par ailleurs, une icône Comportements apparaît à droite du nom de l’objet dans l’onglet 
Couches et la Timeline. Cliquez dessus pour activer ou désactiver tous les comportements 
appliqués à cet objet.
Remarque : dans l’onglet Couches, il est possible de masquer les comportements à 
l’aide du bouton Afficher les comportements, situé en bas à droite. Pour en savoir plus, 
voir « Affichage et masquage des effets » à la page 81.
Si un comportement quelconque est appliqué à un objet de votre projet, une icône 
Comportements (roue) apparaît dans le menu Animation, à droite du paramètre auquel 
il est appliqué dans l’onglet Propriétés, Comportements ou Filtres. Vous savez ainsi 
qu’un comportement modifie ce paramètre.
Une icône Comportements apparaît également dans le menu Animation de chaque 
paramètre modifié dans l’Éditeur d’images clés.
Trajectoires d’animation
Lorsque certains comportements sont appliqués à un objet, une trajectoire d’animation 
apparaît, indiquant le parcours prévu pour cet objet au fil du temps. Considérez 
cette trajectoire comme un « aperçu » de l’animation générée par le comportement. 
Contrairement aux trajectoires d’animation créées avec des images clés ou à la trajectoire 
créée par le comportement Trajectoire d’animation, les trajectoires des comportements 
ne peuvent pas être modifiées. Pour afficher ou masquer tous les types de trajectoire, 
utilisez le menu local Affichage de la Barre d’état.
Icône Comportements
Une icône Comportements est 
affichée dans le menu Animation 
de chaque paramètre modifié.
Une icône Comportements apparaît également 
dans le menu Animation de chaque paramètre 
modifié dans l’Éditeur d’images clés.Chapitre 5 Utilisation des comportements 413
Effets des comportements dans l’Éditeur d’images clés
Si vous ouvrez l’Éditeur d’images clés et observez un paramètre modifié par un ou plusieurs 
comportements, une courbe non modifiable apparaît pour signaler l’effet du comportement sur ce paramètre. La courbe non modifiable s’ajoute à la courbe modifiable du paramètre, qui peut servir à animer ce dernier avec des images clés.
Remarque : utilisez le menu local Afficher de l’Éditeur d’images clés pour sélectionner 
les paramètres à afficher et créer des ensembles de courbes. Pour en savoir plus sur les 
ensembles de courbes, voir « Ensembles de paramètres personnalisés » à la page 581.
Pour en savoir plus sur la combinaison de comportements et d’images clés, 
voir « Combinaison de comportements et d’images clés » à la page 435.
Application et suppression de comportements
Vous avez la possibilité d’appliquer directement des comportements à des objets 
dans le Canevas, l’onglet Couches ou la Timeline. Certains animent automatiquement 
des paramètres spécifiques de la couche à laquelle ils sont appliqués. Par exemple, 
le comportement Lancer modifie uniquement le paramètre Position d’un objet, alors 
que le comportement Grossir/Rétrécir affecte son Échelle. D’autres comportements 
animent les paramètres des couches situées autour de celle à laquelle ils sont appliqués. 
Par exemple, le comportement Attracteur déplace les couches environnantes vers 
la couche modifiée en animant leur paramètre Position.
Important : l’application des comportements Texte, Particules, Réplicateur, Audio, Forme 
et Caméra se limite exclusivement aux objets de même nom. Il est impossible d’appliquer 
des comportements Grossir/rétrécir et Fondu entrant/sortant à des caméras et des lumières.
Remarque : à l’exception de Personnaliser, les comportements Paramètre peuvent 
s’appliquer à un paramètre d’un objet (par exemple, sa position) ainsi qu’à l’objet 
proprement dit. Pour en savoir plus, voir « Application de comportements Paramètre » 
à la page 417.
Courbe modifiable Courbe non modifiable414 Chapitre 5 Utilisation des comportements
Pour appliquer un comportement à un objet, procédez de l’une des manières 
suivantes :
m Faites glisser un comportement de la Bibliothèque sur un objet approprié dans le Canevas, 
l’onglet Couches ou la Timeline.
Pour appliquer un comportement à un objet dans la Timeline, faites glisser ce comportement sur l’objet concerné dans la liste de couches ou la zone de pistes de la Timeline.
Remarque : en règle générale, il est plus facile de faire glisser un comportement sur 
une caméra ou une lumière dans l’onglet Couches ou la Timeline, plutôt que de procéder 
directement dans le Canevas.
L’application d’un comportement depuis la Bibliothèque présente l’avantage de pouvoir 
prévisualiser l’animation créée par le comportement dans la zone de Preview de 
la Bibliothèque.
m Sélectionnez un objet dans le Canevas, l’onglet Couches ou la Timeline, choisissez un 
comportement dans la pile de la Bibliothèque, puis cliquez sur Appliquer dans la zone 
de Preview.
m Sélectionnez un objet dans le Canevas, l’onglet Couches ou la Timeline, cliquez sur 
l’icône Ajouter comportement de la barre d’outils, puis choisissez un comportement.
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Pour appliquer un comportement à plusieurs objets :
1 Sélectionnez tous les objets auxquels vous souhaitez appliquer le comportement. 
Dans l’onglet Couches, le Canevas ou la Timeline, cliquez sur divers objets contigus tout 
en appuyant sur la touche Maj ou sur des objets séparés non contigus tout en maintenant 
la touche Commande enfoncée.
2 Procédez de l’une des manières suivantes :
Â Dans la barre d’outils, cliquez sur l’icône Ajouter comportement et choisissez 
un comportement dans l’un des sous-menus.
Â Sélectionnez un comportement dans la Bibliothèque, puis cliquez sur Appliquer 
dans la zone de prévisualisation.
3 Pour constater l’effet animé, lancez la lecture du projet.
Important : tous les comportements ne génèrent pas automatiquement une animation 
sur un objet. Certains, tels que Lancer, nécessitent que la vitesse de lancement soit définie (dans la palette ou dans l’Inspecteur) avant le « lancement » de l’objet. D’autres, 
comme En orbite, nécessitent la désignation d’un objet source servant d’objet central 
pour que d’autres objets tournent autour.
Lorsqu’un comportement est appliqué à un objet, les paramètres de cet objet affectés 
par ce comportement sont automatiquement animés en fonction des réglages par défaut 
dudit comportement. Par exemple, si vous appliquez le comportement Gravité à un objet 
dans le Canevas, la position de cet objet est animée et il tombe, selon le réglage par 
défaut du comportement Gravité.
Durée par défaut d’un comportement
Dans la majeure partie des cas, la durée d’un comportement correspond à la durée dans 
la Timeline de l’objet auquel il est appliqué. Par exemple, si vous appliquez un comportement Rotation à un objet commençant à l’image 20 et se terminant à l’image 300, 
ce comportement dure également des images 20 à 300. Pour en savoir plus sur la réduction de la durée d’un comportement, voir « Trim des comportements » à la page 431.
Remarque : la préférence « Créer couches à » (dans la sous-fenêtre Projet des préfé-
rences Motion), qui vous permet d’indiquer si les couches doivent être créées sur 
l’image 1 ou au niveau de la position actuelle de la tête de lecture, ne s’applique 
qu’aux couches que vous avez créées ou importées, telles que du texte, des formes 
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Remarque : vous pouvez également appliquer directement des comportements à des 
groupes dans l’onglet Couches ou la Timeline. Selon le comportement appliqué, tous 
les objets imbriqués dans ce groupe sont modifiés soit comme s’il s’agissait d’un seul 
objet, soit individuellement. Vous pouvez souvent modifier le résultat obtenu en 
réglant le paramètre Affecter ou Affecter les sous-objets dans l’onglet Comportements 
de l’Inspecteur.
∏ Astuce : si vous n’observez pas le résultat escompté lorsque vous appliquez des comportements à des objets, tentez d’activer/désactiver le paramètre Affecter les sous-objets 
ou de sélectionner une option différente dans le menu local Affecter. Ces paramètres 
déterminent respectivement si l’ensemble du groupe ou ses composants individuels 
(par exemple, les objets imbriqués dans ce groupe) sont affectés par le comportement, 
ainsi que la façon dont un objet interagit sur les objets environnants.
Remarque : la case à cocher « Affecter les sous-objets » n’apparaît dans l’Inspecteur 
que si les comportements Lancer et Rotation, ou des comportements Simulation, 
sont appliqués à un groupe ou à un objet contenant plusieurs objets, comme 
un émetteur de particules ou du texte.
Suppression de comportements
Sachant que les comportements n’ajoutent aucune image clé, leur suppression élimine 
instantanément leurs effets animés. Tous les types de comportements sont éliminés de 
la même manière.
Pour supprimer un comportement d’un objet:
1 Sélectionnez un comportement dans l’onglet Couches, la Timeline, l’onglet 
Comportements ou le menu local accessible via la barre de titre de la palette.
Dans cet exemple, le comportement Gravité est sélectionné 
dans l’onglet Comportements 
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2 Procédez de l’une des manières suivantes :
Â Choisissez Édition > Supprimer.
Â Appuyez sur la touche Contrôle tout en cliquant sur le comportement dans l’onglet 
Couches ou la Timeline, puis choisissez Supprimer dans le menu contextuel.
Â Appuyez sur la touche Suppr.
Application de comportements Paramètre
Les comportements Paramètre fonctionnent différemment des autres. Tous les comportements affectent des paramètres spécifiques d’un objet. Par exemple, lorsque le comportement Rotation est appliqué à une image, le paramètre Rotation de cette image 
est automatiquement affecté. De même, avec le comportement Fondu entrant/sortant 
appliqué à une séquence, c’est le paramètre Opacité de cette séquence qui est automatiquement affecté, etc. Les comportements Paramètre s’appliquent quant à eux à 
des paramètres distincts d’un objet, d’une caméra, d’un filtre, d’un comportement, etc., 
plutôt qu’à l’objet proprement dit.
Ce point particulier concerne les paramètres des filtres, des émetteurs et des cellules 
des systèmes de particules, les formes, le texte, etc. Vous pouvez également appliquer 
des comportements Paramètre à des paramètres d’autres comportements préalablement 
appliqués à un objet.
Pour simplifier, il suffit d’appliquer un comportement Lancer à une couche de texte 
pour que ce texte traverse le Canevas. Dans ce cas, le comportement Lancer affecte 
le paramètre Position de la couche de texte. S’il s’agit du comportement Osciller appliqué 
au paramètre Position d’une forme, cette forme se déplace alors d’avant en arrière sur 
le Canevas. 
L’effet d’un comportement Paramètre sur un objet dépend du paramètre auquel il est 
appliqué. Par exemple, si vous appliquez le comportement Rendre aléatoire au paramètre 
Position d’un émetteur de particules, ce dernier dérive sur l’écran lors de la lecture 
du projet. En revanche, l’application du même comportement au paramètre Échelle 
d’une forme la fait grossir et rétrécir de façon aléatoire.
Important : même si vous appliquez un comportement Paramètre à un objet par 
le biais de la Bibliothèque ou de l’icône Ajouter comportement de la barre d’outils, 
ce comportement n’affecte pas l’objet concerné tant que vous n’avez pas sélectionné 
le paramètre précis auquel vous souhaitez appliquer ce comportement. Une méthode 
plus directe pour ajouter un comportement Paramètre consiste à utiliser le menu 
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Pour appliquer un comportement Paramètre à un paramètre spécifique d’objet :
1 Sélectionnez l’objet auquel vous souhaitez appliquer le comportement Paramètre.
2 Procédez de l’une des manières suivantes :
Â Appuyez sur la touche Contrôle tout en cliquant sur un paramètre dans l’Inspecteur, 
puis choisissez un comportement Paramètre dans le menu contextuel.
Â Appuyez sur la touche Contrôle tout en cliquant sur un paramètre dans la palette, 
puis choisissez un comportement Paramètre dans le menu contextuel.
Â Appuyez sur la touche Contrôle tout en cliquant sur un paramètre dans l’Éditeur 
d’images clés, puis choisissez un comportement Paramètre dans le menu local.
Dans cet exemple, le comportement 
Osciller est appliqué au paramètre 
Rotation d’une forme. 
Dans cet exemple, le comportement Rendre aléatoire est appliqué 
au paramètre Adoucissement des 
bords d’une forme. Chapitre 5 Utilisation des comportements 419
Remarque : utilisez le menu local Afficher pour choisir les paramètres à afficher 
dans l’Éditeur d’images clés. Pour en savoir plus, voir « Commandes de filtrage » 
à la page 578.
Une fois qu’un comportement de paramètre est appliqué à un paramètre, l’Inspecteur 
bascule automatiquement vers l’onglet Comportements.
Pour appliquer un comportement Paramètre à un objet :
1 Procédez de l’une des manières suivantes :
Â Faites glisser un comportement Paramètre de la Bibliothèque sur un objet approprié 
dans le Canevas, l’onglet Couches ou la Timeline
Â Sélectionnez un objet dans le Canevas, l’onglet Couches ou la Timeline, cliquez sur 
l’icône Ajouter comportement de la barre d’outils, puis choisissez un comportement 
Paramètre.
Remarque : en règle générale, il est plus facile de faire glisser un comportement 
sur une caméra ou une lumière dans l’onglet Couches ou la Timeline, plutôt que 
de procéder directement dans le Canevas.
Ce comportement est appliqué à l’objet, mais aucun paramètre ne lui est encore affecté. 
2 Pour affecter un paramètre spécifique à un comportement Paramètre, procédez 
de l’une des manières suivantes :
Â Sélectionnez un comportement Paramètre, puis choisissez un paramètre dans 
le menu local Appliquer à (« Aller ») de la palette.
Â Sélectionnez le comportement Paramètre, puis choisissez un comportement Paramètre 
dans le menu local Appliquer à (« Aller ») de l’onglet Comportements de l’Inspecteur.
Sitôt affecté, le paramètre auquel le comportement est appliqué apparaît dans le 
champ Appliquer à.
Remarque : si vous enregistrez un comportement Paramètre comme favori, son paramètre affecté est enregistré avec ses autres réglages. En conséquence de quoi, ce comportement peut être appliqué comme n’importe quel autre et le paramètre du nouvel 
objet est automatiquement affecté.
Dans cet exemple, 
le comportement Rendre 
aléatoire est appliqué au 
paramètre Opacité d’une 
forme. 420 Chapitre 5 Utilisation des comportements
Application de comportements Paramètre à des paramètres d’animation 3D
Dès lors que des comportements Paramètre sont appliqués à des paramètres incluant 
des canaux 3D, comme Position et Rotation, un paramètre par défaut est affecté. 
Il s’agit en fait de l’effet le plus fréquemment utilisé. Par exemple, si le comportement 
Osciller est appliqué au paramètre Rotation d’un objet (dans l’onglet Propriétés), 
ce comportement est affecté par défaut au paramètre Z.
Dans l’animation créée, l’image effectue un mouvement de va-et-vient le long de l’axe Z.
Pour que le comportement affecte à un autre paramètre, utilisez le paramètre Appliquer 
à accessible via la palette des comportements Paramètre ou l’Inspecteur.
Pour modifier l’affectation d’un comportement Paramètre :
m Dans la palette du comportement ou l’Inspecteur, choisissez un autre paramètre dans 
le menu local Appliquer à (« Aller »). Dans cet exemple concernant le comportement 
Osciller, l’oscillation est appliquée aux axes X et Y de l’objet affecté.
Par défaut, le comportement Osciller est 
appliqué au paramètre Rotation Z.Chapitre 5 Utilisation des comportements 421
Dans l’animation créée, l’image effectue un mouvement de va-et-vient le long des 
axes X et Y.
Pour en savoir plus sur la réaffectation des comportements Paramètre, voir « Attribution 
d’un comportement Paramètre à un autre paramètre » à la page 422.
Emplacement des comportements Paramètre
Dans l’onglet Couches et la Timeline, les comportements Paramètre, comme tous 
les autres comportements, apparaissent imbriqués en dessous de l’objet auquel 
ils sont appliqués, avec le reste des comportements appliqués à cet objet.
Remarque : même si les comportements Paramètre apparaissent imbriqués sous 
les objets dans la liste de couches, gardez à l’esprit qu’ils ne sont appliqués qu’à 
un seul paramètre de ces objets, et pas aux objets proprement dits.
L’icône d’un comportement Paramètre affiche un entonnoir. Cet objet symbolise 
la « canalisation » des différents paramètres.
Comportement Paramètre
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Ouvrez le menu Animation d’un paramètre dans l’Inspecteur pour afficher les noms 
de tous les comportements appliqués à ce paramètre. La sélection du nom d’un de 
ces comportements ouvre automatiquement l’onglet Comportements de l’élément 
correspondant.
Comme dans le cas de tous les autres comportements, sitôt qu’un comportement 
Paramètre est appliqué à un objet de votre projet, une icône Comportements apparaît 
dans le menu Animation du paramètre affecté (dans l’onglet Propriétés, Comportements 
ou Filtres où il est appliqué), ainsi que dans le menu Animation de chaque paramètre 
affecté (dans l’Éditeur d’images clés). 
Attribution d’un comportement Paramètre à un autre paramètre
Une fois un comportement de Paramètre appliqué à un paramètre, il reste attribué 
jusqu’à une nouvelle attribution. Pour ce faire, il est possible d’utiliser le menu local 
Appliquer à (« Aller »), situé en bas des commandes du comportement Paramètre 
dans la palette ou l’onglet Comportements.
Le menu local Appliquer à (« Aller ») affiche toutes les propriétés disponibles 
pour l’objet auquel le comportement est appliqué. Si un objet est affecté par d’autres 
comportements ou filtres, ces paramètres apparaissent également dans les sous-menus 
de ce menu local.
Pour réaffecter un comportement Paramètre à un autre paramètre dans la palette :
1 Dans l’onglet Couches, la Timeline ou l’onglet Comportements de l’Inspecteur, 
sélectionnez le comportement de paramètre que vous souhaitez réaffecter.
2 Dans la palette, choisissez un nouveau paramètre dans le menu local Appliquer à (« Aller »).
Le comportement de paramètre est appliqué au nouveau paramètre choisi et le champ 
« Appliquer à » est mis à jour afin de refléter la nouvelle affectation. Dans l’Inspecteur, 
l’icône Comportements apparaît désormais en regard du nouveau paramètre.
Dans cet exemple, les comportements 
Osciller et Rendre aléatoire sont appliqués 
au paramètre Taille du filtre Cristalliser.Chapitre 5 Utilisation des comportements 423
Pour réaffecter un comportement de paramètre à un autre paramètre dans 
l’Inspecteur :
1 Sélectionnez l’objet doté du comportement Paramètre que vous souhaitez réaffecter.
2 Dans l’onglet Comportements de l’Inspecteur, choisissez un nouveau paramètre dans 
le menu local Appliquer à (« Aller »).
Comportement Suivi du paramètre
Le comportement Suivi du paramètre vous permet de suivre un paramètre particulier 
d’un effet, tel que le point central d’une lumière parasite, par rapport à un point 
de référence d’un plan. Par exemple, vous pouvez faire en sorte qu’un rayon lumineux 
soit émis à partir d’un objet en mouvement dans un plan en effectuant le suivi du plan, 
puis en appliquant le comportement Suivi de paramètre au paramètre Centre du filtre 
Rayons de lumière. Pour en savoir plus sur l’utilisation du comportement Suivi du 
paramètre, consultez « Suivi de l’animation » dans le manuel PDF Documentation supplémentaire de Motion.
Modification des comportements
La palette de chaque comportement affiche un sous-ensemble (parfois même, un 
ensemble complet) des paramètres disponibles. Si besoin est, tous les paramètres des 
comportements sont visibles dans l’onglet Comportements de l’Inspecteur. Comme la 
palette et l’onglet Comportements font référence aux mêmes paramètres, leur modification dans l’un se répercute automatiquement dans l’autre.424 Chapitre 5 Utilisation des comportements
Modification des paramètres dans la palette
En règle générale, la palette d’un comportement se limite à afficher les paramètres 
les plus importants pour modifier l’effet de ce comportement. Qui plus est, les commandes 
qu’elle met à votre disposition sont bien souvent plus explicites et plus simples à utiliser 
que celles qui figurent l’onglet Comportements, même si ce dernier en contient davantage. 
À titre d’exemple, il vous suffit de comparer les commandes affichées par l’onglet 
Comportements et la palette pour le comportement Fondu entrant/sortant :
Comme vous pouvez le constater, les commandes de la palette réunissent deux 
des paramètres disponibles dans l’onglet Comportements sous la forme d’une seule 
commande graphique. Pourtant, il est des cas où il est préférable d’utiliser les paramè-
tres individuels d’un comportement afin de peaufiner l’effet recherché, notamment 
en ayant la possibilité de saisir des valeurs précises.
Pour afficher la palette d’un comportement:
1 Sélectionnez un objet auquel un comportement est appliqué.
2 Procédez de l’une des manières suivantes :
Â Dans l’onglet Couches, la Timeline ou l’onglet Comportements de l’Inspecteur, 
sélectionnez le comportement que vous souhaitez modifier.
Â Dans le Canevas, cliquez sur un objet tout en maintenant la touche Contrôle enfoncée, 
puis choisissez un comportement dans le sous-menu Comportements du menu 
contextuel.
Remarque : si la palette n’apparaît pas, choisissez Fenêtre > Afficher la palette 
(ou appuyez sur F7 ou sur D).
3 Apportez des modifications au comportement grâce aux commandes de la palette.Chapitre 5 Utilisation des comportements 425
Pour passer en revue les palettes d’un objet, procédez de l’une des manières 
suivantes :
m Cliquez sur le triangle d’affichage dans la barre de titre de la palette (à droite du titre) 
pour ouvrir un menu local répertoriant tous les comportements et filtres appliqués à cet 
objet. Choisissez un élément proposé dans la liste pour afficher la palette correspondante.
m Sélectionnez un objet dans le Canevas, puis appuyez sur la touche D pour afficher 
la palette suivante parmi toutes les palettes disponibles pour cet objet. Pour revenir 
à la précédente, appuyez sur Maj + D.
Personnalisation de paramètres dans l’onglet Comportements 
de l’Inspecteur
L’onglet Comportements de l’Inspecteur présente tous les comportements appliqués 
à l’objet sélectionné. Un triangle d’affichage à gauche du nom de chaque comportement révèle tous ses paramètres. Contrairement à la palette, l’onglet Comportements 
affiche tous les paramètres d’un comportement.
Pour afficher l’onglet Comportements :
1 Sélectionnez un objet auquel un comportement est appliqué.
2 Ouvrez l’Inspecteur et cliquez sur l’onglet Comportements.
Tous les comportements appliqués figurent alors dans l’onglet.
Utilisation des comportements
Cette rubrique vous explique comment activer, renommer, verrouiller, dupliquer, déplacer et réorganiser des comportements dans votre projet. Les procédures décrites s’appliquent à tous les types de comportements.
Cliquez sur ce triangle d’affichage, 
puis sélectionnez un comportement 
ou un filtre pour afficher sa palette. 426 Chapitre 5 Utilisation des comportements
Activation, rebaptisation et verrouillage de comportements
Lorsque vous appliquez un comportement à un objet, il apparaît à trois endroits : 
l’onglet Couches, la Timeline et l’onglet Comportements de l’Inspecteur.
Alors que l’onglet Comportements de l’Inspecteur met à votre disposition tous 
les paramètres modifiables d’un comportement appliqué à un objet, l’onglet Couches 
et la Timeline vous présentent plusieurs commandes pour chaque comportement :
Case d’activation : active ou désactive chaque comportement individuel. Les comportements désactivés sont sans incidence sur l’objet auquel ils sont appliqués.
Nom : double-cliquez dans ce champ pour renommer le comportement.
Verrouiller : cliquez sur cette icône pour verrouiller ou déverrouiller un comportement. 
Vous ne pouvez pas modifier les paramètres d’un comportement verrouillé.
Activer/Désactiver les comportements : une icône Comportements (roue) apparaît 
à droite du nom de chaque objet auquel un ou plusieurs comportements sont appliqués. 
Cliquez sur cette icône pour activer et désactiver tous les comportements appliqués 
à cet objet.
Case Activation Nom Activer/Désactiver les comportements
Verrouiller
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Remarque : cliquez sur l’icône Comportements tout en maintenant la touche Contrôle 
enfoncée pour ouvrir un menu local répertoriant tous les comportements appliqués à cet 
objet. Choisissez un comportement dans ce menu pour l’afficher dans l’Inspecteur.
Bouton Afficher les comportements : il apparaît au bas de l’onglet Couches et 
de la Timeline et vous permet d’afficher ou de masquer tous les comportements. 
Ce bouton n’active ou ne désactive pas les comportements appliqués aux objets 
de votre projet : il se contente de contrôler leur affichage.
Copie, collage et déplacement de comportements
Après avoir ajouté des comportements à un objet, vous pouvez les copier et les déplacer 
de diverses manières parmi les autres objets présents dans la Timeline ou l’onglet Couches.
Il est possible de couper, copier et coller des comportements comme n’importe quel autre 
objet dans Motion. Lorsque vous coupez ou copiez un comportement dans la Timeline 
ou l’onglet Couches, vous pouvez également copier l’état en cours de tous ses paramètres.
Pour couper ou copier un comportement :
1 Sélectionnez un comportement.
2 Procédez de l’une des manières suivantes :
Â Choisissez Édition > Couper (ou appuyez sur les touches Commande + X) 
pour supprimer le comportement et le placer dans le Presse-papiers.
Â Choisissez Édition > Copier (ou appuyez sur les touches Commande + C) 
pour conserver le comportement à cet endroit et le copier dans le Presse-papiers.
Pour coller un comportement :
1 Sélectionnez l’objet sur lequel vous souhaitez coller le comportement.
2 Choisissez Édition > Coller (ou appuyez simultanément sur les touches Commande + V).
Le comportement coupé ou copié est appliqué à l’objet sélectionné, tous les réglages 
de ses paramètres ayant été conservés.
Dans l’onglet Couches ou la liste de couches de la Timeline, vous pouvez également 
déplacer un comportement d’un objet vers un autre en le faisant simplement glisser 
vers un nouvel emplacement. 
Cliquez sur l’icône Comportements tout en 
maintenant la touche Contrôle enfoncée, 
puis choisissez un comportement pour l’afficher 
dans l’Inspecteur.
Le bouton Afficher les comportements est activé.428 Chapitre 5 Utilisation des comportements
Pour transférer un comportement d’un objet à un autre :
m Dans l’onglet Couches ou la liste de couches de la Timeline, faites glisser un comportement 
appliqué à un objet et déposez-le sur un autre objet.
Remarque : si vous déplacez un comportement Paramètre d’un objet vers un autre, 
il est appliqué au même paramètre que précédemment, si tant est que ce paramètre 
soit présent dans le nouvel objet. Si ce paramètre n’existe pas, l’affectation du paramètre 
(champ Appliquer à) est définie sur aucune.
Vous pouvez également dupliquer un comportement.
Pour dupliquer un comportement :
1 Sélectionnez le comportement à dupliquer.
2 Procédez de l’une des manières suivantes :
Â Choisissez Édition > Dupliquer (ou appuyez simultanément sur les touches 
Commande + D).
Â Appuyez sur la touche Contrôle tout en cliquant sur le comportement à dupliquer, 
puis choisissez Dupliquer dans le menu contextuel.
Vous pouvez également dupliquer un comportement, puis appliquer sa copie à 
un autre objet dans l’onglet Couches ou dans la liste de couches de la Timeline.
Pour faire glisser la copie d’un comportement vers un autre objet :
m Tout en maintenant la touche Option enfoncée, faites glisser le comportement vers 
l’objet auquel vous souhaitez appliquer le comportement dupliqué.
Le comportement dupliqué est alors appliqué au second objet et sa version d’origine 
reste à son emplacement initial.
Lorsque vous dupliquez un objet, vous dupliquez également tous les comportements 
qui lui sont appliqués. De cette façon, si vous créez un projet avec un certain nombre 
d’objets nécessitant tous le même comportement, il vous suffit d’appliquer ce comportement à la première occurrence de l’objet, puis de dupliquer cet objet autant de fois 
que nécessaire.
Glissement d’un comportement
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Application de plusieurs comportements à un objet
Il n’existe aucune limite au nombre de comportements que vous pouvez appliquer 
à un objet. Si plusieurs comportements sont appliqués à un seul objet, ils contribuent 
tous au résultat de l’effet d’animation.
Sachant que chaque comportement applique une valeur à un paramètre donné, 
les valeurs générées par tous les comportements ayant une incidence sur les mêmes 
paramètres se combinent pour donner le résultat final. Par exemple, si vous appliquez 
les comportements Lancer, Gravité et Rotation à un seul objet, le résultat combiné 
est garanti par les deux premiers qui affectent sa position et le troisième qui affecte 
sa rotation.
Réorganisation des comportements
Lorsque vous appliquez plusieurs comportements à un seul objet, ils apparaissent tous 
en dessous de cet objet dans la Timeline et l’onglet Couches. Vous pouvez toutefois 
changer leur ordre d’application. Même si les effets de la plupart des comportements 
se complètent, il s’agit plus d’une technique utile d’organisation que d’une façon de 
changer l’effet animé créé par les comportements. Le comportement Arrêter est une 
exception à la règle : il interrompt l’activité de tous les comportements apparaissant en 
dessous de son niveau dans la liste de couches et qui ont une incidence sur le même 
paramètre, alors qu’il n’affecte en rien les comportements situés au-dessus.
Pour reclasser un comportement :
1 Faites glisser le comportement que vous souhaitez repositionner plus haut ou plus bas 
dans la liste des comportements imbriqués appliqués à un même objet. Un indicateur 
de position signale la place du comportement lorsque vous relâchez le bouton de 
la souris.
2 Lorsque l’indicateur de position signale l’emplacement souhaité, relâchez le bouton 
de la souris.
Un indicateur de position apparaît chaque 
fois que vous faites glisser un comportement 
dans la liste.430 Chapitre 5 Utilisation des comportements
Changement du contrôle du temps des comportements
Vous pouvez changer la durée d’un comportement pour contrôler le moment où 
il commence, sa durée et quand il finit. Pour ce faire, vous pouvez procéder de plusieurs 
manières : en utilisant le comportement de paramètre Arrêter afin d’interrompre 
les effets d’un ou plusieurs comportements sur un paramètre ou en effectuant un Trim 
pour chaque comportement dans la Timeline. Vous pouvez tout aussi bien modifier 
le paramètre Début de décalage de certains comportements pour retarder leur commencement ou leur paramètre Fin du décalage pour qu’ils se terminent avant la fin 
de l’objet auquel ils sont appliqués. Les comportements concernés sont les suivants : 
Fondu entrant/sortant, Grossir/rétrécir et Magnétiser l’alignement sur l’animation.
Utilisation du comportement de paramètre Arrêter
Le plus simple pour contrôler la durée d’un comportement consiste à utiliser le comportement de paramètre Arrêter. Ce comportement interrompt l’animation au niveau 
d’un seul paramètre, qu’elle soit due à des images clés dans l’Éditeur d’images clés 
ou à des comportements appliqués à l’objet concerné.
Comme indiqué dans « Application de comportements Paramètre » à la page 417, 
tous les comportements Paramètre s’appliquent directement à un paramètre d’un objet 
(comme l’opacité ou la position) ou à un objet (comme du texte ou une image). 
Toutefois, si le comportement est appliqué directement à un objet, un paramètre 
doit lui être explicitement affecté (dans l’onglet Comportements de l’Inspecteur).
Pour arrêter l’animation d’un paramètre :
1 Placez la tête de lecture sur l’image à partir de laquelle vous souhaitez que l’animation 
cesse.
2 Sélectionnez l’objet concerné, puis ouvrez l’onglet Propriétés de l’Inspecteur.
3 Appuyez sur la touche Contrôle tout en cliquant sur le paramètre à arrêter, puis choisissez 
Arrêter dans le menu contextuel.
Le paramètre est animé jusqu’à l’image à partir de laquelle commence le comportement 
Arrêter.
Remarque : lorsque le comportement Arrêter est utilisé de cette manière, il est appliqué 
sur l’image actuelle (quel que soit le réglage de la préférence « Créer couches à »).
4 Pour affecter le comportement Arrêter à un autre paramètre, choisissez un nouveau 
paramètre dans le menu local Appliquer à (« Aller »).
Le comportement Arrêter interrompt l’animation de tous les comportements appliqués 
au paramètre sélectionné de cet objet. Par exemple, si vous appliquez les comportements 
Gravité, Collision sur les bords et Rotation à une forme, puis que vous appliquez 
le comportement Arrêter au paramètre Position de la couche de cette forme, la forme 
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Pour contrôler l’arrêt de l’animation ayant une incidence sur ce paramètre, ajustez 
le comportement Arrêter dans la Timeline. Pour en savoir plus sur l’ajustement 
des comportements, voir la rubrique suivante page 431.
Pour en savoir plus sur l’application des comportements Paramètre, voir « Application 
de comportements Paramètre » à la page 417.
Trim des comportements
Lorsque vous appliquez un comportement à un objet, sa durée dans la Timeline équivaut 
par défaut à la durée de l’objet auquel il est appliqué.
Il est possible de modifier un comportement pour limiter la durée de son effet. 
Par exemple, si vous appliquez le comportement Rotation à la couche d’un réplicateur, 
ce dernier pivote par défaut sur toute sa durée. Si vous effectuez un Trim du point de 
sortie du comportement Rotation, la rotation s’arrête à la nouvelle position du point 
de sortie.
Pour modifier la durée d’un comportement dans la Timeline :
1 Déplacez le pointeur vers le point d’entrée ou de sortie d’un comportement dans 
la Timeline.
2 Lorsque le pointeur change pour permettre un Trim, procédez de l’une des manières 
suivantes :
Â Faites glisser le point d’entrée pour retarder le début de l’effet du comportement.
Â Faites glisser le point de sortie pour terminer l’effet du comportement avant la fin 
de l’objet.
Remarque : lorsque vous faites glisser le point d’entrée ou de sortie d’un comportement, 
une bulle d’aide apparaît et en signale le nouvel emplacement et la durée actualisée.
Par défaut, un comportement adopte la même 
durée que l’objet auquel il est appliqué.
Une bulle d’aide signale la nouvelle 
position du point de sortie.432 Chapitre 5 Utilisation des comportements
L’application d’un Trim sur le point de sortie d’un comportement restaure bien souvent 
l’objet dans son état d’origine sitôt le point de sortie atteint. Pour de nombreux comportements, il est donc bien plus efficace d’interrompre l’animation d’un objet à l’aide du 
comportement Arrêter, plutôt que d’appliquer un Trim à son point de sortie. Pour arrêter 
l’effet d’un comportement et conserver l’objet concerné dans son état transformé, une 
autre méthode consiste à régler les paramètres Début et Fin du décalage du comportement. Pour en savoir plus, voir « Changement du décalage des comportements 
Paramètre » à la page 434.
Remarque : les comportements Simulation ne permettent pas de conserver l’objet 
dans son état transformé au-delà de la dernière image du comportement ayant subi 
un Trim. Pour en savoir plus, voir « Contrôle des comportements Simulation » à la 
page 432.
Contrôle des comportements Simulation
Il vous faut bien garder à l’esprit que les comportements (à l’exception des comportements Suivi de l’animation) ont pour but de vous permettre de créer des graphismes 
animés d’une grande fluidité, qui ne nécessitent aucun contrôle particulier du temps. 
Les comportements Simulation répondent tout spécialement à cet objectif, en vous 
permettant de créer avec un travail de montage réduit au strict minimum des interactions 
très élaborées entre plusieurs objets de votre projet.
Contrairement aux comportements Animation standard, vous ne pouvez pas arrêter 
ou modifier l’animation d’un comportement Simulation dans la Timeline. Toutefois, 
vous pouvez affecter sa vitesse en modifiant sa durée dans la Timeline. Vous avez 
également la possibilité de changer son image de début.
Les comportements Simulation figurant des phénomènes naturels, comme la Gravité, 
les lois de l’inertie s’appliquent : c’est une force extérieure qui met l’objet en mouvement 
et il le reste, même si ladite force n’est plus en présence. Modifier la durée de la barre 
d’un comportement Simulation dans la Timeline interrompt donc la force « à l’œuvre » 
sur l’objet, mais ne saurait mettre fin au mouvement de l’objet. Vous pouvez évidemment contrôler les comportements Simulation grâce à leurs paramètres.Chapitre 5 Utilisation des comportements 433
Dans l’illustration suivante, le comportement En orbite (Simulation) est appliqué à 
un grand cercle. Le texte central est défini comme l’objet autour duquel le cercle doit 
se déplacer. La trajectoire d’animation représentée en rouge figure le parcours du cercle 
sur toute sa durée. Le comportement En orbite est de la même durée (300 images) 
que le grand cercle auquel il est appliqué. 
Dans l’illustration suivante, un Trim est appliqué au comportement En orbite afin de 
réduire sa durée (190 images) par rapport à l’objet auquel il est appliqué. Vous remarquez 
alors le changement apparu sur la trajectoire d’animation : sur l’image 190, où le comportement En orbite prend fin, l’objet (la forme du cercle) cesse de tourner autour de 
sa cible, mais continue à se déplacer vers l’extérieur du Canevas. Le comportement 
En orbite, la fameuse force à l’œuvre, n’est plus en présence, mais le mouvement 
du cercle ne cesse pas pour autant.
Déplacement de comportements dans le temps
Outre la modification de la durée d’un comportement, vous pouvez changer sa position 
dans la Timeline par rapport à l’objet sous lequel il est imbriqué. Vous pouvez ainsi 
déterminer l’image à laquelle ce comportement commence.
Le comportement En orbite, appliqué au grand cercle, est de la même durée que l’objet auquel il est 
appliqué. La trajectoire d’animation (en rouge) indique le déplacement du cercle sur toute sa durée.
La durée du comportement En orbite est plus courte que la durée de l’objet auquel il est appliqué. 
La trajectoire d’animation indique alors l’effet raccourci du comportement sur le déplacement du cercle.434 Chapitre 5 Utilisation des comportements
Pour déplacer un comportement dans la Timeline :
1 Cliquez n’importe où au milieu de la barre du comportement dans la Timeline.
2 Faites glisser le comportement vers la gauche ou vers la droite pour le déplacer dans 
la Timeline.
Au déplacement de la barre, une bulle d’aide apparaît et présente les nouveaux points 
d’entrée et de sortie du comportement. Elle affiche également la valeur delta correspondant au nombre d’images dont la barre s’est déplacée.
Changement du décalage des comportements Paramètre
Certains comportements Paramètre mettent à votre disposition deux paramètres supplémentaires, Début du décalage et Fin du décalage, qui vous permettent de changer 
l’image au niveau de laquelle leur effet commence ou se termine.
Le paramètre Début du décalage est doté d’un curseur permettant de retarder le début 
de l’effet d’un comportement par rapport à la première image de sa position dans 
la Timeline. Vous pouvez régler ce paramètre afin que le comportement de paramètre 
commence plus tard.
Le paramètre Fin du décalage permet de décaler la fin de l’effet du comportement 
par rapport à la dernière image de sa position dans la Timeline. Utilisez ce curseur pour 
arrêter l’effet, au lieu d’effectuer un Trim sur la fin du comportement dans la Timeline : 
vous pouvez ainsi bloquer l’effet du comportement sur l’objet pour le temps restant.
L’exemple suivant illustre l’utilisation des paramètres Début et Fin du décalage avec 
le comportement Pente.
Pour utiliser les paramètres Début et Fin du décalage :
1 Sélectionnez un objet (une forme, par exemple).
2 Dans l’onglet Propriétés de l’Inspecteur, cliquez sur le paramètre Échelle tout en maintenant la touche Contrôle enfoncée, puis choisissez Pente dans le menu contextuel.
Le comportement Pente (de la catégorie Paramètre) est appliqué au paramètre Échelle 
de l’objet et l’onglet Comportements est affiché. Ce comportement vous permet de 
créer une transition progressive au sein de tout paramètre qu’il est possible d’animer.Chapitre 5 Utilisation des comportements 435
3 Réglez les valeurs Début et Fin sur 0 et 200, puis lancez la lecture du projet.
L’objet est redimensionné sur la base de son échelle d’origine, de telle sorte 
qu’il atteigne deux fois sa taille initiale sur toute sa durée.
4 Réglez les paramètres Début du décalage et Fin du décalage sur 90.
L’objet n’est pas redimensionné jusqu’à l’image 90 et sa mise à l’échelle cesse 
à 90 images de sa dernière image dans la Timeline.
Combinaison de comportements et d’images clés
Il est possible d’appliquer à la fois des comportements et des images clés à un objet. 
Dans ce cas, les valeurs générées par le comportement et celles des images clés appliquées 
au paramètre se combinent pour donner une valeur finale à ce paramètre. Vous pouvez 
donc bénéficier de la commodité des comportements et du contrôle direct de l’animation avec des images clés pour obtenir votre résultat final.
Par exemple, si vous appliquez le comportement Animation aléatoire à une forme, 
celle-ci risque de se déplacer sur l’écran selon une trajectoire d’animation totalement 
aléatoire ressemblant à l’illustration suivante :
Si vous désactivez temporairement le comportement Animation aléatoire et que vous 
créez une trajectoire d’animation à l’aide d’images clés, vous pouvez créer un mouvement 
totalement prévisible et fluide.
Trajectoire d’animation 
aléatoire
Trajectoire d’animation 
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Vous pouvez combiner les deux procédures afin d’activer à nouveau le comportement 
Animation aléatoire, ce qui donne une trajectoire d’animation répondant aux attentes 
globales, mais dont les variations la rendent intéressante.
Cet exemple montre comment associer des comportements et des images clés pour 
créer des trajectoires d’animation. La démarche est aussi valable pour n’importe quel 
paramètre. 
Combinaison de comportements et d’images clés dans l’Éditeur d’images clés
Lorsque vous affichez un paramètre modifié par un comportement dans l’Éditeur 
d’images clés, deux courbes correspondantes apparaissent. L’une d’elles, non modifiable, 
apparaît en arrière-plan et présente le paramètre tel qu’il est modifié par le comportement. 
Cette courbe ne comporte aucune image clé. Superposée à cette courbe indiquant 
l’effet du comportement sur le paramètre, vous observez une deuxième courbe 
modifiable correspondant au paramètre proprement dit.
Trajectoire d’animation aléatoire 
combinée avec une trajectoire 
d’animation avec des images clés
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Vous avez la possibilité d’animer un paramètre avec des images clés, avant ou après 
l’application d’un comportement à l’objet qui le modifie. Lorsque vous animez avec 
des images clés un paramètre déjà modifié par un comportement, la valeur de la courbe 
comportant des images clés est associée à celle générée par le comportement à chaque 
image, ce qui augmente ou diminue la valeur finale affichée par la courbe en arrière-plan. 
Cette dernière, outre les valeurs animées du comportement, affiche aussi la somme de 
toutes les valeurs ayant une incidence sur ce paramètre.
Le fait d’élever ou de baisser une image clé dans l’Éditeur d’images clés déplace dans 
le même sens la courbe en arrière-plan, sachant que les valeurs générées par le comportement subissent des modifications.
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Important : la valeur affichée dans l’Inspecteur pour le paramètre modifié reflète 
le résultat combiné final des images clés et des comportements appliqués à ce 
paramètre. La modification des valeurs d’un paramètre directement dans l’Inspecteur 
ne fait qu’altérer la valeur sous-jacente du paramètre, qu’il soit ou non animé avec 
des images clés. Cette valeur est ensuite combinée avec l’effet du comportement 
pour donner une valeur finale éventuellement différente de celle que vous avez saisie.
Pour en savoir plus sur la manière d’utiliser les images clés dans l’Éditeur d’images clés, 
voir le chapitre 6, « Images et clés et courbes », à la page 547.
Important : lorsque vous combinez des images clés avec plusieurs comportements, 
les résultats peuvent paraître imprévisibles, en fonction de l’assortiment de comportements appliqués.
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Vous pouvez convertir en images clés les comportements appliqués à tous les paramè-
tres d’un objet. La conversion de comportements déjà combinés avec des images clés 
convertit l’ensemble des comportements et images clés ayant une incidence sur le 
paramètre en une série réduite d’images clés (une courbe avec moins d’images clés). 
Vous obtenez ainsi une courbe d’animation finale dont la forme est très proche de la 
courbe en arrière-plan dans l’Éditeur d’images clés. Ces images clés peuvent ensuite 
être modifiées directement dans l’Éditeur d’images clés.
Pour en savoir plus sur la conversion de comportements en images clés, 
voir « Conversion de comportements en images clés » à la page 441.
Animation de paramètres de comportements
Vous pouvez animer la plupart des paramètres de comportements pour changer leur 
effet sur la durée. Pour cela, vous pouvez recourir à des comportements de paramètre 
ou ajouter des images clés dans l’Éditeur d’images clés.
Avant Après conversion en images clés440 Chapitre 5 Utilisation des comportements
Application de comportements Paramètre à un comportement
Vous pouvez animer le paramètre d’un comportement en lui appliquant un comportement Paramètre. Par exemple, vous pouvez appliquer le comportement Osciller au 
paramètre Glissement du comportement En orbite et régler les valeurs Début et Fin 
pour qu’elles passent progressivement de 0 à 8 au fil du temps. L’orbite de l’objet 
diminue petit à petit, jusqu’à ce que l’objet tombe vers le centre de l’orbite. 
Pour en savoir plus sur l’ajout de comportements Paramètre, voir « Application de comportements Paramètre » à la page 417.
Animation de comportements avec des images clés
Pour un contrôle plus précis lors de l’animation des paramètres d’un comportement, 
utilisez des images clés. Par exemple, si vous animez le paramètre Glissement du comportement En orbite avec des images clés, vous pouvez grossir et rétrécir de nombreuses 
fois l’orbite de l’objet et obtenir ainsi une trajectoire d’animation bien plus complexe. 
Il serait très difficile d’animer manuellement avec des images clés cette trajectoire 
d’animation : ici, il suffit d’animer un seul paramètre d’un comportement en particulier 
pour obtenir facilement cet effet.
Pour en savoir plus sur l’animation de paramètres avec des images clés, 
voir « Animation de comportements » à la page 559.
Objet avec le paramètre En orbite Comportement de paramètre Osciller ajouté au 
paramètre Glissement du comportement En orbite
Comportement En orbite par défaut Comportement En orbite par défaut avec le 
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Conversion de comportements en images clés
Les comportements sont tout spécialement adaptés à la création d’effets fluides ne 
nécessitant aucun contrôle précis du temps. Dans certains projets, vous pouvez toutefois avoir besoin d’un plus grand contrôle sur les effets animés créés à l’aide de comportements. Si le cas se présente, sachez que plusieurs comportements peuvent être 
convertis en images clés. Il est donc possible de convertir les courbes d’animation 
créées par les comportements (sans aucune image clé) en courbes d’animation animées avec des images clés. Vous pouvez ensuite modifier les images clés obtenues 
dans l’Éditeur d’images clés, afin de mieux répondre à vos besoins de précision en 
matière de contrôle du temps. 
Comme de nombreux comportements (quoique pas tous) affectent les mêmes paramètres 
d’un objet, tous les comportements appliqués à un objet sont convertis en images clés 
lorsque vous convertissez cet objet ou un de ses comportement en images clés. Les images 
clés sont alors appliquées à des paramètres individuels que les comportements modifiaient avant leur conversion. Les deux comportements Gravité et Lancer affectent par 
exemple le paramètre Position : vous ne pouvez donc pas convertir le comportement 
Gravité en images clés, sans affecter le comportement Lancer. Lorsque des comportements appliqués à d’autres objets modifient l’objet converti (par exemple, les comportements Attracteur ou Repousser), leur effet devient la valeur des images clés de l’objet. 
Les comportements d’origine restent appliqués aux autres objets, mais l’effet obtenu 
n’est pas doublé du fait de la combinaison des images clés et du comportement.
Remarque : il est impossible de convertir en images clés plusieurs des comportements 
Simulation, Réplicateur, Particules et Texte. En effet, certains comportements Simulation, 
comme Vortex, peuvent affecter les paramètres de tous les objets d’un projet et la conversion de ce type de comportement risquerait de créer un nombre incalculable d’images 
clés. N’oubliez pas que tout l’intérêt de ces comportements est de créer automatiquement 
une animation extrêmement complexe, qui vous réclamerait bien trop d’heures de 
travail à animer manuellement avec des images clés.
Si un comportement (ou un objet auquel des comportements sont appliqués) peut 
être converti, le menu Objet propose la commande « Convertir en images clés » 
dès que ce comportement ou cet objet est sélectionné. Lorsque cette commande 
est estompée, vous savez qu’il est impossible de générer des images clés à partir 
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Pour convertir des comportements en images clés :
1 Procédez de l’une des manières suivantes :
Â Sélectionnez un objet avec des comportements que vous souhaitez convertir.
Â Dans l’Inspecteur, sélectionnez le comportement que vous souhaitez convertir.
2 Choisissez Objet > Convertir en images clés (ou appuyez sur les touches 
Commande + K).
Une zone de dialogue vous invite à confirmer la conversion en images clés.
3 Cliquez sur Convertir.
Tous les comportements sont convertis en images clés, lesquelles apparaissent dans 
l’Éditeur d’images clés. L’intégralité de l’animation de l’objet est convertie en images 
clés, même si certains comportements sont situés en dehors de la plage temporelle 
de l’objet.
Remarque : vous ne pouvez effectuer une conversion sélective de comportements 
individuels. En effet, la commande « Convertir en images clés » convertit simultanément 
tous les comportements appliqués à un objet. 
Enregistrement et partage de comportements personnalisés
Vous pouvez enregistrer n’importe quel objet de Motion dans la Bibliothèque, y compris 
des caméras, des lumières, des filtres et des comportements personnalisés, des groupes 
et des couches (systèmes de particules, réplicateurs, formes et texte personnalisés). 
Il est également possible d’enregistrer dans la Bibliothèque des objets animés avec 
des comportements ou des images clés. Ils conservent alors leur animation s’ils sont 
appliqués à un autre projet.
Vous avez la possibilité d’enregistrer des comportements personnalisés dans un dossier 
existant de la Bibliothèque, comme la catégorie Favoris, ou de créer un nouveau dossier 
au sein d’une catégorie existante. Dès lors qu’il est placé dans la Bibliothèque, un comportement peut être ajouté à un projet comme n’importe quel autre objet de la Bibliothèque. Les comportements enregistrés dans la Bibliothèque apparaissent avec une 
icône personnalisée.
Remarque : dans le Finder, les éléments enregistrés dans la Bibliothèque portent l’extension .molo (pour « Motion Library object »). Il est impossible de les ouvrir directement à 
partir du Finder.
Vous pouvez enregistrer de multiples objets dans la Bibliothèque sous la forme d’un 
seul ou de plusieurs fichiers. Par exemple, si vous créez une animation à partir de plusieurs comportements et que vous souhaitez sauvegarder l’effet cumulé obtenu, vous 
pouvez enregistrer tous les comportements sous la forme d’un seul élément dans la 
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Même si vous avez la possibilité d’enregistrer vos comportements personnalisés dans 
la catégorie Comportements, il est plutôt recommandé de sauvegarder tous les éléments 
que vous utilisez fréquemment dans la catégorie Favoris. Certaines catégories de la 
Bibliothèque de Motion contiennent tellement d’éléments que les catégories Favoris et 
Menu Favoris peuvent vous faire gagner du temps lors de vos recherches. Vous pouvez 
d’ailleurs créer d’autres dossiers au sein de la catégorie Favoris afin d’organiser au 
mieux vos éléments personnalisés.
Les comportements enregistrés dans la catégorie Menu Favoris s’appliquent très 
rapidement à des objets grâce au menu Favoris.
Vous pouvez également créer de nouveaux dossiers dans des catégories existantes, 
comme Favoris ou Comportements. Les dossiers créés dans la catégorie Comportements 
apparaissent dans la barre latérale de la Bibliothèque. En revanche, les dossiers créés 
dans des sous-catégories, comme Animation standard, sont affichés dans la pile de 
la Bibliothèque mais pas dans sa barre latérale.
Pour enregistrer un comportement dans la Bibliothèque :
1 Ouvrez la Bibliothèque, puis sélectionnez la catégorie Favoris, Menu Favoris 
ou Comportements.
2 Faites glisser le comportement personnalisé à enregistrer de l’onglet Couches, 
de la Timeline ou de l’Inspecteur dans la pile au bas de la Bibliothèque.
Lorsque vous enregistrez un comportement personnalisé, il est placé dans le dossier /
Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/
Motion/Bibliothèque.
Remarque : si vous faites glisser un comportement personnalisé vers une autre souscatégorie, comme Éclat (dans la catégorie Filtres), il est automatiquement placé dans 
la catégorie Comportements, qui est alors activée.
Pour enregistrer plusieurs comportements dans la Bibliothèque :
1 Ouvrez la Bibliothèque, puis sélectionnez la catégorie Favoris, Menu Favoris 
ou Comportements.
2 Dans l’onglet Couches, sélectionnez tous les comportements que sous souhaitez 
enregistrer, faites-les glisser dans la pile et maintenez le bouton de la souris enfoncé 
jusqu’à ce qu’un menu déroulant apparaisse.
3 Choisissez « Tous dans un fichier » ou « Fichiers multiples » dans le menu déroulant, 
puis relâchez le bouton de la souris.
L’option « Tous dans un fichier » enregistre tous les comportements ensemble et 
ils sont ensuite répertoriés comme un seul élément dans la Bibliothèque. À l’inverse, 
l’option « Fichiers multiples » enregistre les comportements dans la Bibliothèque 
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4 Pour attribuer un nom au(x) fichier(s), procédez de l’une des manières suivantes :
Â Maintenez la touche Contrôle enfoncée en cliquant sur l’icône, choisissez Renommer 
dans le menu contextuel, puis tapez un nom descriptif.
Â Sélectionnez l’icône, cliquez sur « sans titre », puis tapez un nom descriptif.
Remarque : si vous cliquez sur l’icône tout en maintenant la touche Contrôle enfoncée, 
l’option Modifier la description apparaît. Il s’agit d’un outil très pratique qui vous permet de rédiger des notes personnelles sur un élément enregistré dans la Bibliothèque. 
Après avoir choisi Modifier la description, tapez vos notes dans le champ de texte, puis 
cliquez sur OK.
Pour créer un nouveau dossier dans la catégorie Comportements, Favoris ou Menu 
Favoris :
1 Ouvrez la Bibliothèque, puis sélectionnez la catégorie Comportements, 
Favoris ou Menu Favoris.
2 Procédez de l’une des manières suivantes :
Â Cliquez sur le bouton Nouveau dossier situé en bas de la fenêtre.
Â Dans la pile de la Bibliothèque (la partie inférieure), cliquez tout en maintenant 
la touche Contrôle enfoncée sur une zone vide, puis choisissez Nouveau dossier 
dans le menu local.
Remarque : vous serez sans doute amené à développer la fenêtre de la pile ou à 
activer la présentation sous forme d’icônes pour avoir accès à une zone vide.
Un dossier sans titre apparaît dans la liste des sous-catégories affichée dans la barre 
latérale de la Bibliothèque.
3 Alors que ce nouveau dossier est sélectionné, cliquez sur son nom, saisissez un nouveau 
nom, puis appuyez sur Retour.Chapitre 5 Utilisation des comportements 445
Pour créer un nouveau dossier dans une sous-catégorie de comportements :
1 Ouvrez la Bibliothèque, puis sélectionnez une sous-catégorie de comportements 
(Animation standard, par exemple).
2 Procédez de l’une des manières suivantes :
Â Cliquez sur le bouton Nouveau dossier situé en bas de la fenêtre.
Â Dans la pile de la Bibliothèque (la partie inférieure), cliquez tout en maintenant 
la touche Contrôle enfoncée sur une zone vide, puis choisissez Nouveau dossier 
dans le menu local.
Le nouveau dossier sans titre apparaît dans la pile de la Bibliothèque. Il n’est pas répertorié 
dans la barre latérale de la Bibliothèque.
3 Alors que ce nouveau dossier est sélectionné, cliquez sur son nom, saisissez un nouveau 
nom, puis appuyez sur Retour.
Pour déplacer un comportement vers un dossier personnalisé au sein de la catégorie 
Comportements :
m Faites glisser le comportement dans le nouveau dossier dans la barre latérale de 
la Bibliothèque.
Le préréglage personnalisé est ajouté au nouveau dossier ainsi qu’à la sous-catégorie Tout.
Pour déplacer un comportement vers un dossier personnalisé au sein 
d’une sous-catégorie de comportements :
m Faites glisser le comportement dans le nouveau dossier de la sous-catégorie 
de comportements dans la pile de la Bibliothèque. 
Le préréglage personnalisé est ajouté au nouveau dossier ainsi qu’à la sous-catégorie Tout.
Pour supprimer un comportement personnalisé :
m Dans la pile de la Bibliothèque, cliquez sur le comportement personnalisé avec la touche 
Contrôle enfoncée, puis choisissez Placer dans la Corbeille dans le menu contextuel.
Pour supprimer un dossier personnalisé d’une sous-catégorie dans la pile de 
la Bibliothèque :
m Dans la pile, cliquez sur le dossier tout en maintenant la touche Contrôle enfoncée, 
puis choisissez Placer dans la Corbeille dans le menu contextuel.
Remarque : vous pouvez également supprimer ce dossier à partir du Finder. Il est 
situé dans le dossier suivant : /Utilisateurs/nom d’utilisateur/Bibliothèque/Application 
Support/Final Cut Studio/Motion/Bibliothèque.
Important : il est impossible d’annuler la suppression d’un objet ou d’un dossier 
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Pour supprimer un dossier personnalisé d’une catégorie dans la barre latérale 
de la Bibliothèque :
m Dans le Finder, accédez au dossier /Utilisateurs/nom d’utilisateur/Bibliothèque/Application 
Support/Final Cut Studio/Motion/Bibliothèque, cliquez dessus tout en maintenant la touche 
Contrôle enfoncée, puis choisissez Placer dans la Corbeille dans le menu contextuel.
Transfert de comportements entre différents ordinateurs
Chaque comportement personnalisé glissé dans la Bibliothèque est enregistré comme 
fichier distinct dans le dossier /Final Cut Studio/Motion du répertoire Application 
Support. Par exemple, un comportement personnalisé appelé « My Motion Path » 
placé dans le dossier Favoris de la Bibliothèque apparaît dans le dossier /Utilisateurs/
nom d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/Motion/Bibliothè-
que/Favoris.
Dans le Finder, les éléments enregistrés dans la Bibliothèque portent l’extension .molo
(pour « Motion Library object »). Il est impossible de les ouvrir directement à partir 
du Finder.
Si vous avez créé un ou plusieurs comportements personnalisés fiables, vous pouvez 
les transférer vers d’autres ordinateurs sur lesquels Motion est installé.
Pour copier un comportement personnalisé sur un autre ordinateur :
1 Quittez Motion.
2 Copiez un ou plusieurs fichiers de préréglages Motion personnalisés dans le dossier /
Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/
Motion/Bibliothèque de cet ordinateur.
3 Redémarrez Motion.
Descriptions de comportements
Cette rubrique présente les paramètres disponibles pour chaque comportement 
dans Motion, selon la catégorie.
Remarque : un chapitre séparé est consacré aux comportements Audio, Suivi de 
l’animation, Forme, Particules, Réplicateur et Caméra.Chapitre 5 Utilisation des comportements 447
Comportements Animation standard
Ces comportements animent des paramètres spécifiques de l’objet auquel ils sont 
appliqués. Certains ont une incidence sur la position, d’autres sur l’échelle, la rotation 
ou l’opacité.
Fondu entrant/sortant
Ce comportement vous permet de réaliser un fondu entrant ou sortant d’un objet. 
Il modifie l’opacité de l’objet auquel il est appliqué, avec un fondu de 0 à 100 % 
d’opacité au début de l’objet, puis un retour à 0 % d’opacité à la fin. Vous pouvez 
éliminer les fondus en fixant leur durée sur 0 image.
Remarque : ce comportement est multiplicateur. Autrement dit, les paramètres Fondu 
entrant et Fondu sortant sont multipliés par l’opacité actuelle de l’objet afin d’obtenir 
un niveau de transparence. 
Le comportement Fondu entrant/sortant est très pratique pour faire apparaître et 
disparaître des éléments animés au milieu d’un projet. Par exemple, vous pouvez 
appliquer le comportement Fondu entrant/sortant à un texte traversant l’écran, de telle 
sorte qu’il apparaisse en fondu et disparaisse de la même façon à la fin de sa durée.
Remarque : il est impossible d’appliquer le comportement Fondu entrant/sortant à 
une caméra ou à une lumière.
Commandes disponibles dans la palette
La palette vous permet de contrôler les durées de fondu entrant et sortant, équivalentes 
aux paramètres Temps du fondu entrant et Temps du fondu sortant présents dans 
l’onglet Comportements de l’Inspecteur. Faites glisser l’élément n’importe où dans 
la zone ombrée de la barre Fondu entrant ou Fondu sortant pour en régler la durée.
Remarque : il vous suffit de continuer à glisser au-delà des limites de la commande graphique affichée par la palette pour augmenter les durées de fondu entrant et sortant.
Exemples d’utilisation de comportements Animation standard
Pour prendre connaissance d’exemples d’utilisation de certains des comportements 
Animation standard, voir « Exemples de comportements » à la page 528.
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Paramètres dans l’Inspecteur
Temps du fondu entrant : curseur fixant la durée (en images) du fondu de l’objet de 0 
à 100 % d’opacité, à partir de sa première image. Une durée égale à 0 image provoque 
une coupe nette vers l’intérieur de l’objet, ce qui le fait apparaître instantanément.
Temps du fondu sortant : curseur fixant la durée (en images) du fondu de l’objet de 
100 à 0 % d’opacité, à partir de sa dernière image. Une durée égale à 0 image provoque 
une coupe nette vers l’extérieur d’objet, ce qui le fait disparaître instantanément.
Début du décalage : curseur permettant de retarder le début de l’effet d’un comportement par rapport à la première image de sa position dans la Timeline. Réglez ce paramètre pour que le comportement commence plus tard. La valeur de ce paramètre est 
exprimée en images.
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement 
par rapport à la dernière image de sa position dans la Timeline, en images. Réglez ce 
paramètre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. 
Utilisez ce curseur pour décaler la fin de l’effet Fondu sortant de la fin de l’objet.
Grossir/Rétrécir
Ce comportement vous permet d’animer l’échelle d’un objet, en augmentant ou en 
réduisant sa taille au fil du temps à une vitesse fixée par le paramètre Taux d’adaptation 
ou Changer la taille de. L’effet Grossir/Rétrécir commence toujours à la taille d’origine 
de l’objet, à partir de la première image du comportement. 
Remarque : il est impossible d’appliquer le comportement Grossir/Rétrécir à des caméras 
ou à des lumières.
∏ Conseil : pour dimensionner les particules sur leur durée de vie, utilisez le comportement 
de particule Échelle sur longévité. Pour en savoir plus, voir « Utilisation des comportements Particules » à la page 801.
Remarque : les taux d’augmentation verticale et horizontale peuvent être définis indé-
pendamment, pour des effets asymétriques.
Le comportement Grossir/Rétrécir s’avère utile dans le cas de graphismes de résolution 
élevée à zoomer dans une image, tels qu’un plan ou une photographie. Vous pouvez 
également combiner ce comportement à Lancer ou Vent pour un déplacement dans 
l’image au moment du zoom avant.
Il peut également servir à accentuer ou à estomper des images de votre projet. Vous 
pouvez agrandir des objets afin qu’ils attirent l’attention ou les réduire au moment d’en 
intégrer un nouveau pour que le spectateur tourne son regard vers ce nouvel élément.Chapitre 5 Utilisation des comportements 449
Commandes disponibles dans la palette
La palette du comportement Grossir/Rétrécir est divisée en deux parties rectangulaires. 
La première, un rectangle avec une ligne en pointillés, correspond à la taille d’origine 
de l’objet. La seconde est un rectangle solide qui illustre le taux d’augmentation relatif 
et peut être redimensionné en glissant l’un de ses bords. Agrandissez ou réduisez 
ce rectangle pour grossir ou rétrécir l’objet cible. Un curseur situé à droite vous permet 
de déterminer l’échelle des commandes disponibles dans la palette, ce qui augmente 
ou diminue leur effet sur l’objet.
Paramètres dans l’Inspecteur
Incrémentation : ce menu local permet de décider la progression de l’effet du comportement sur sa durée dans la Timeline. Il existe trois options :
Â Pente continue : cette option se sert du paramètre Taux d’adaptation pour grossir 
ou rétrécir l’objet avec un nombre constant de pixels par seconde.
Â Pente constante jusqu’à la valeur finale : cette option grossit ou rétrécit l’objet 
à partir de sa taille d’origine selon le pourcentage et l’échelle d’origine définis dans 
le paramètre Changer la taille de. Si le comportement est raccourci dans la Timeline, 
l’effet Grossir/rétrécir est plus rapide.
Â Grandeur nature : activée par défaut, cette option utilise une courbe exponentielle 
pour permettre à l’animation de progresser lentement lorsque les valeurs d’échelle 
sont faibles et d’accélérer lorsque les valeurs sont importantes. Cette méthode crée 
l’illusion que le redimensionnement est effectué à vitesse constante.
Taux d’adaptation/Changer la taille de : en fonction de la commande choisie dans 
le menu local Incrémentation, le paramètre Taux d’adaptation ou Changer la taille 
de fixe la vitesse et l’ampleur de l’effet. Ce paramètre peut être ouvert dans des sousparamètres X et Y en cliquant sur le triangle d’affichage à gauche. Vous pouvez ainsi 
régler indépendamment l’échelle horizontale et verticale.
Paramètre Taux d’adaptation/Changer la taille de
Niveau de zoom des commandes de la palette
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Courbure : ce paramètre vous permet de régler l’accélération du passage de la taille 
d’origine à celle finale. Avec des valeurs élevées, l’entrée et la sortie de l’effet sont fluides, 
la taille de l’objet commençant à changer progressivement et de plus en plus rapidement 
au fil du déroulement du comportement. La courbure ne modifie pas toute la durée 
de l’effet : celle-ci est définie par la longueur du comportement dans la Timeline, moins 
la valeur de Fin du décalage.
Remarque : le paramètre Courbure n’est pas disponible si le paramètre Incrémentation 
est réglé sur Grandeur nature.
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement 
par rapport à la dernière image de sa position dans la Timeline, en images. Réglez ce 
paramètre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. 
Utilisez ce curseur pour décaler la fin de l’effet Grossir/rétrécir de la fin de l’objet.
Trajectoire d’animation
Ce comportement vous permet de créer la trajectoire d’animation 2D ou 3D qu’un 
objet doit suivre. Lorsque vous appliquez le comportement Trajectoire d’animation 
pour la première fois, sa forme par défaut correspond à Spline ouvert, à savoir une 
ligne droite définie par deux points, au début et à la fin de la trajectoire. Vous pouvez 
toutefois choisir d’autres formes de trajectoires prédéfinies, telles que Spline fermé, 
Boucle, Rectangle ou Vagues, voire utiliser une forme pour définir la trajectoire. 
Dans ce dernier cas, la forme utilisée comme source de la trajectoire d’animation 
peut aussi être animée.
Vous avez la possibilité de modifier la trajectoire d’animation en 3D, de telle sorte 
que l’objet parcourt cette trajectoire selon les axes X, Y et Z. Pour en savoir plus, 
voir « Modification d’une trajectoire d’animation dans un espace 3D » à la page 460.
Le premier point correspond à la position de l’objet dans le Canevas au niveau de 
la première image du comportement. Il vous suffit de cliquer n’importe où sur la trajectoire 
tout en maintenant la touche Option enfoncée pour lui ajouter des points de Bézier, 
ce qui vous permet d’en modifier la forme en créant des courbes.
Trajectoire 
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Remarque : pour afficher ou masquer la trajectoire d’animation, choisissez Afficher 
les incrustations dans le menu local Affichage de la Barre d’état. (L’option Trajectoire 
d’animation sert à prévisualiser la trajectoire des autres comportements.)
Lors de la lecture du projet, l’objet se déplace le long de la trajectoire qui lui est affectée. 
Sa vitesse de déplacement correspond à la durée du comportement. Elle est également 
modifiée par le paramètre Vitesse, qui vous permet de modifier la vitesse de l’objet, 
en ajoutant une accélération et un ralentissement au début et à la fin du comportement, 
par exemple. Vous pouvez également créer un préréglage personnalisé pour définir 
la façon dont l’objet se déplace le long de sa trajectoire.
Remarque : lorsque vous activez différentes options pour la forme de la trajectoire, 
l’Inspecteur et la palette affichent des paramètres propres à l’option sélectionnée. 
Pour en savoir plus sur les paramètres propres aux formes, voir « Paramètres dans 
l’Inspecteur » à la page 452. Pour tous les autres paramètres, voir « Paramètres toujours 
disponibles dans l’Inspecteur » à la page 457.
Grâce au comportement Trajectoire d’animation, vous pouvez créer facilement une animation prévisible sans recourir à l’Éditeur d’images clés. Il permet aussi de créer des trajectoires d’animation réutilisables en les enregistrant dans la Bibliothèque en vue d’une 
future utilisation.
Commandes disponibles dans la palette
Dans la palette, les commandes suivantes sont toujours disponibles : Forme de la trajectoire, Type de forme, Direction, Vitesse, Appliquer vitesse (qui détermine le nombre 
de fois où l’objet parcourt la trajectoire sur toute sa durée) et Condition de fin. 
En revanche, d’autres paramètres ne sont disponibles qu’en fonction des options 
sélectionnées pour le paramètre Forme de la trajectoire.
Contrôles supplémentaires à l’écran
Lorsque vous appliquez le comportement Trajectoire d’animation à un objet, l’outil 
Ajuster l’élément est automatiquement sélectionné, ce qui vous permet de modifier 
la trajectoire par défaut dans le Canevas. Vous pouvez alors lui ajouter des points 
et utiliser les commandes Bézier (ou B-Spline) associées à chaque point afin d’ajuster 
les différentes courbes. Vous avez également la possibilité de déplacer et de redimensionner dans le Canevas les formes prédéfinies de trajectoires d’animation, telles qu’un 
rectangle ou des vagues.452 Chapitre 5 Utilisation des comportements
Éloignement de l’objet par rapport à la trajectoire d’animation
Par défaut, l’objet est verrouillé sur la trajectoire d’animation par son point d’ancrage.
Pour éloigner l’objet de la trajectoire, sélectionnez l’outil Point d’ancrage dans la barre 
d’outils, puis déplacez son point d’ancrage dans le Canevas. Pour en savoir plus sur 
l’utilisation de l’outil Point d’ancrage, voir « Modification du point d’ancrage d’un 
objet » à la page 305.
Remarque : le réglage d’un paramètre Décalage séparé vous permet de décaler 
l’emplacement du début de l’objet sur la trajectoire d’animation (sans pour autant 
décaler l’objet de la trajectoire). Pour en savoir plus sur le paramètre Décalage, voir 
« Paramètres dans l’Inspecteur, » ci-après.
Déplacement de l’objet et de sa trajectoire d’animation
Pour déplacer un Objet et sa trajectoire d’animation, sélectionnez l’objet concerné 
(et non le comportement Trajectoire d’animation), puis déplacez-le dans le Canevas.
Paramètres dans l’Inspecteur
Cette rubrique traite des commandes disponibles pour le comportement Trajectoire 
d’animation en fonction de l’option sélectionnée dans le menu local Forme de 
la trajectoire. La rubrique suivante, « Paramètres toujours disponibles dans l’Inspecteur » 
à la page 457, est consacrée aux commandes qui sont toujours à votre disposition 
(quelle que soit l’option sélectionnée dans le menu local Forme de la trajectoire).
Forme de la trajectoire : menu local vous permettant de sélectionner la forme de 
la trajectoire le long de laquelle l’objet se déplace.
Remarque : les paramètres Forme de la trajectoire fonctionnent comme dans le cas 
d’un texte sur une trajectoire. Pour en savoir plus sur l’utilisation d’un texte sur 
une trajectoire, voir « Manipulation du texte sur une trajectoire » à la page 687.Chapitre 5 Utilisation des comportements 453
Â Spline ouvert : forme par défaut. Il s’agit d’une ligne droite définie par deux points 
situés au début et à la fin de la trajectoire. Vous pouvez choisir de travailler avec des 
points de contrôle Bézier ou B-Spline. Cliquez n’importe où sur la trajectoire tout en 
maintenant la touche Option enfoncée (ou double-cliquez dessus) pour ajouter des 
points de contrôle.
Â Spline fermé : trajectoire fermée sur laquelle le dernier point est situé au même 
endroit que le premier. Vous pouvez choisir de travailler avec des points de contrôle 
Bézier ou B-Spline. Cliquez n’importe où sur la trajectoire tout en maintenant la touche 
Option enfoncée (ou double-cliquez dessus) pour ajouter des points de contrôle.
Â Type de forme : si vous avez sélectionné Spline ouvert ou Spline fermé pour la forme 
de la trajectoire, ce menu local vous permet de choisir l’une des deux méthodes 
de manipulation de la forme de la trajectoire : Bézier ou B-Spline.
Â Bézier : vous permet de manipuler la courbe d’images clés manuellement en faisant 
glisser les poignées.
Remarque : pour en savoir plus sur la création et l’ajustement des courbes de Bézier, 
voir « Modification des points de contrôle de Bézier » à la page 1102.
Â B-Spline : les courbes B-Spline se manipulent uniquement à l’aide des points (elles 
ne comportent pas de poignées tangentes). Les points ne sont d’ailleurs pas situés 
à la surface de la forme. En effet, chaque point de contrôle B-Spline est décalé par 
rapport à la surface de la forme, attirant cette section de la forme vers lui à la manière 
d’un aimant, pour créer la courbe. Les courbes B-Splines sont extrêmement lisses. 
Par défaut, elles ne comportent aucun angle aigu, même si vous pouvez créer des 
courbes plus marquées, si besoin.
Remarque : pour en savoir plus sur la manipulation des courbes B-Spline, 
voir « Modification de points de contrôle B-Spline » à la page 1105.
Â Cercle : version simplifiée de la forme Spline fermé, dans laquelle il est possible 
de modifier le rayon X ou Y pour créer un cercle ou une ellipse.
Â Rayon : si vous avez sélectionné Cercle pour la forme de la trajectoire, ce curseur 
vous permet de modifier la taille de la trajectoire circulaire. Cliquez sur le triangle 
d’affichage pour régler séparément les rayons X et Y.454 Chapitre 5 Utilisation des comportements
Remarque : si le comportement Trajectoire d’animation est sélectionné, vous pouvez 
également utiliser les commandes à l’écran pour redimensionner le cercle. Appuyez 
sur Maj pour conserver les proportions des rayons X et Y.
Â Rectangle : trajectoire fermée sur laquelle il est possible d’ajuster la largeur et 
la hauteur pour créer un carré ou un rectangle.
Â Taille : si vous avez sélectionné Rectangle pour la forme de la trajectoire, ce curseur 
vous permet de modifier la taille de la trajectoire rectangulaire. Cliquez sur le triangle 
d’affichage pour régler séparément les échelles X et Y. 
Remarque : si le comportement Trajectoire d’animation est sélectionné, vous pouvez 
également utiliser les commandes à l’écran pour redimensionner le rectangle. 
Appuyez sur Maj pour conserver les proportions des échelles X et Y.
Â Décalage : si vous avez sélectionné Cercle, Rectangle ou Géométrie pour la forme 
de la trajectoire, ce curseur vous permet d’indiquer où l’objet doit commencer à se 
déplacer sur la trajectoire.
Â Vagues : trajectoire en forme d’onde (sinusoïdale) définie par deux points situés 
au début et à la fin de la trajectoire, et contrôlée par les paramètres Point d’arrivée, 
Amplitude, Fréquence, Phase et Humidité.
Â Points d’arrivée : déterminent l’emplacement des deux points par défaut sur 
la trajectoire d’une vague. Ces points peuvent également être déplacés à l’aide 
des commandes à l’écran de la vague (activés par défaut si le comportement 
Trajectoire d’animation est sélectionné). Si vous déplacez le point d’arrivée situé 
à gauche, vous déplacez l’ensemble de la trajectoire. Si vous déplacez le point 
d’arrivée situé à droite, vous rallongez ou raccourcissez la trajectoire, voire modifiez 
son angle.
Â Amplitude : définit la moitié de la distance du point le plus élevé au point le plus 
bas dans la vague. Les valeurs élevées entraînent des vagues plus extrêmes.
Â Fréquence : définit le nombre de vagues. Plus la valeur indiquée est importante, 
plus les vagues sont nombreuses.
Utilisation des points de contrôle 
extérieurs pour redimensionner 
la forme circulaire ou rectangulaire 
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Â Phase : cadran permettant de définir le décalage (en degrés) des vagues entre 
le point de départ et le point final de leur trajectoire. Si cette option est réglée 
sur 0 degré (la valeur par défaut), les vagues commencent et se terminent à la moitié 
de la distance séparant les points le plus haut et le plus bas dans les vagues. 
À 90 degrés, les vagues commencent et se terminent au niveau du point le plus 
haut des vagues. À –90 degrés, les vagues commencent au niveau du point le plus 
bas des vagues. À 180 degrés, les vagues sont les mêmes qu’avec un réglage 
sur 0 degré, mais elles sont inversées.
Â Humidité : curseur permettant de diminuer progressivement l’oscillation des vagues. 
Des valeurs positives entraînent la diminution des vagues vers l’avant (de gauche 
à droite). Des valeurs négatives ont l’effet inverse (de droite à gauche).
Valeur Humidité d’une forme Vagues réglée sur 0 Valeur Humidité réglée sur 3
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Â Géométrie : l’objet se déplace le long du contour d’une forme ou d’un masque 
utilisé comme source pour la trajectoire.
Â Attacher à la forme : si cette option est activée, la trajectoire d’animation suit 
la forme source à son emplacement d’origine. Dans le cas contraire, la trajectoire 
d’animation peut exister à un autre emplacement que sa forme source.
Remarque : si l’option Attacher à la forme est activée, vous ne pouvez pas déplacer 
l’objet à un autre emplacement.
Pour aligner la rotation d’un objet de telle sorte qu’elle corresponde à toutes 
les modifications apportées à sa position le long d’une trajectoire d’animation, 
appliquez le comportement Magnétiser l’alignement sur l’animation. Pour en savoir 
plus, voir « Magnétiser l’alignement sur l’animation » à la page 465.
Â Source de la forme : cadre d’image définissant l’objet (forme ou masque) à utiliser 
comme source de trajectoire animée.
Â Vers : menu local répertoriant tous les objets du projet en cours pouvant servir 
de forme source pour la trajectoire d’animation.
Trajectoire d’animation définie dans le cadre 
Source de la forme
Couche de forme utilisée comme source de 
la forme
Couche de forme sur une trajectoire avant l’application du comportement Magnétiser l’alignement 
sur l’animation
Couche de forme sur une trajectoire après 
l’application du comportement Magnétiser 
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Utilisation de la forme Géométrie pour une trajectoire d’animation
La rubrique suivante décrit l’utilisation de la forme Géométrie comme source d’une trajectoire d’animation. Vous pouvez même choisir une forme animée à l’aide de comportement ou d’images clés comme source d’une trajectoire d’animation, ce qui comprend 
les transformations animées (une forme changeant d’emplacement dans le Canevas) 
et les points de contrôle animés (une forme changeant de forme du fait de points 
de contrôle animés avec des images clés).
Pour utiliser la forme Géométrie pour une trajectoire d’animation :
1 Importez (ou dessinez) la forme que vous souhaitez utiliser comme source de trajectoire.
2 Choisissez Géométrie dans le menu local Forme de la trajectoire.
Le cadre Source de la forme apparaît aussi bien dans l’Inspecteur que dans la palette.
3 Dans l’onglet Couches, faites glisser la forme vers le cadre Source de la forme.
4 Lorsque le pointeur devient une flèche courbe, relâchez le bouton de la souris.
Une vignette représentant la forme apparaît dans le cadre et elle est utilisée comme 
source pour la forme de la trajectoire d’animation.
Remarque : vous pouvez avoir envie de désactiver la forme source dans l’onglet 
Couches, afin qu’elle ne soit pas visible dans votre projet.
Pour sélectionner une autre forme Géométrie comme source d’une trajectoire 
d’animation :
1 Choisissez l’objet à utiliser comme forme source de la trajectoire d’animation dans 
le menu local « Vers » (situé en regard du cadre Source de la forme).
Remarque : pour aligner la rotation de l’objet à la forme de sa trajectoire d’animation, 
appliquez le comportement Magnétiser l’alignement sur l’animation (dans la sous-caté-
gorie de comportements Animation standard).
Paramètres toujours disponibles dans l’Inspecteur
Les paramètres suivants du comportement Trajectoire d’animation sont disponibles 
quelle que soit la forme de la trajectoire.
Choisissez un autre objet de votre 
projet à utiliser comme forme source 
de la trajectoire d’animation dans 
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Direction : menu local qui définit la direction dans laquelle l’objet se déplace sur 
la trajectoire. Deux options sont possibles :
Â En avant : l’objet se déplace vers l’avant de la trajectoire d’animation (du premier 
au dernier point de la trajectoire, en tenant compte du paramètre Décalage).
Â En arrière : l’objet se déplace vers l’arrière de la trajectoire d’animation (du dernier 
au premier point de la trajectoire, en tenant compte du paramètre Décalage).
Remarque : le paramètre Décalage est disponible si vous avez choisi Cercle 
ou Rectangle comme forme de trajectoire.
Vitesse : menu local qui définit la vitesse de l’objet, du premier au dernier point de 
la trajectoire d’animation. Vous avez huit choix possibles :
Â Constante : l’objet se déplace à vitesse constante, du premier au dernier point de 
la trajectoire d’animation.
Â Atténuation en entrée : l’objet démarre à une vitesse réduite, puis atteint et conserve 
une vitesse constante jusqu’au dernier point de la trajectoire d’animation.
Â Atténuation en sortie : l’objet commence à une vitesse constante, puis ralentit progressivement pour s’arrêter au niveau du dernier point de la trajectoire d’animation.
Â Atténuation en entrée/sortie : l’objet accélère progressivement à partir du premier 
point de la trajectoire d’animation, pour ensuite ralentir graduellement et s’arrêter 
au dernier point.
Â Accélérer : la vitesse de déplacement de l’objet sur la trajectoire est croissante.
Â Ralentir : la vitesse de déplacement de l’objet sur la trajectoire est décroissante.
Â Nature : la vitesse de déplacement de l’objet le long de la trajectoire dépend de 
la forme de cette trajectoire. Par exemple, si la trajectoire a la forme d’une courbe 
en U, l’objet se déplace de plus en plus vite au fur et à mesure qu’il descend vers 
la base du U, puis il ralentit en remontant la deuxième barre du U.
Â Personnaliser : vous permet de définir le déplacement de l’objet le long de sa trajectoire 
en définissant des images clés pour la vitesse de l’objet, allant de 0 à 100 pour cent. 
Autrement dit, vous déterminez la position au fil du temps de l’objet le long de 
la trajectoire.
Â Vitesse personnalisée : ce paramètre est disponible lorsque Vitesse est configuré 
sur Personnaliser. Vous pouvez modifier la courbe de vitesse personnalisée dans 
l’Éditeur d’images clés. Vous pouvez animer avec des images clés des valeurs 
personnalisées, afin de déplacer un objet, par exemple, jusqu’à un certain pourcentage de sa trajectoire, puis en sens inverse, puis à nouveau dans le bon sens, etc., 
avant qu’il atteigne la fin de l’animation.
Appliquer vitesse : si vous avez réglé le paramètre Boucles sur une valeur supérieure 
à 1, cette option détermine comment le paramètre Vitesse est appliqué sur toute 
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Remarque : le paramètre Boucles doit être réglé sur une valeur supérieure à 1 pour 
que le paramètre Appliquer vitesse ait le moindre effet.
Â Une fois par boucle : la vitesse (définie par le paramètre Vitesse) est appliquée 
à chaque boucle. Par exemple, si le paramètre Boucles est réglé sur 3 et Vitesse 
sur Accélérer, l’objet accélère à chaque fois qu’il parcourt sa trajectoire. La vitesse est 
alors appliquée sur toute la durée du comportement et le réglage Boucles est ignoré. 
Â Sur la durée totale : la vitesse (définie par le paramètre Vitesse) est appliquée une 
seule fois sur toute la durée du comportement. Par exemple, si le paramètre Boucles 
est réglé sur 3 et Vitesse sur Accélérer, l’objet accélère la première fois qu’il parcourt 
sa trajectoire, mais pas la deuxième ni la troisième fois.
Boucles : définit le nombre de fois où l’objet parcourt la trajectoire d’animation sur 
toute la durée du comportement. Pour qu’un objet parcourt plusieurs fois sa trajectoire d’animation, avec un effet de « ping-pong », le paramètre Boucles doit être réglé 
sur une valeur supérieure à 1.
Condition de fin : menu local qui définit le comportement de l’objet une fois qu’il a 
atteint la fin de sa trajectoire d’animation.
Â Répéter : l’objet parcourt sa trajectoire d’animation autant de fois que défini par 
le paramètre Boucles.
Â Ping-Pong : l’objet se déplace le long de sa trajectoire jusqu’à parvenir au dernier 
point de cette trajectoire, puis il repart en arrière vers le premier point. Le nombre 
d’allers et retours est défini par le paramètre Boucles.
Points de contrôle : cliquez sur le triangle d’affichage pour afficher les paramètres 
Position des points de contrôle de la trajectoire d’animation. Les trois champs correspondent aux valeurs X, Y et Z.
Remarque : il est impossible d’appliquer des comportements Paramètre aux points 
de contrôle.
Pour utiliser le paramètre Vitesse personnalisée :
1 Dans l’Inspecteur ou la palette, choisissez Personnaliser dans le menu local Vitesse.
Le paramètre Vitesse personnalisée devient disponible. Par défaut, une image clé est définie aux points de début et de fin du comportement, afin de créer une animation allant de 
0 à 100 % : à 0, l’objet est au début de la trajectoire, alors qu’à 100, il se trouve à la fin de 
la trajectoire. Il s’agit de la même vitesse que celle utilisée avec le préréglage Constante.
2 Activez l’enregistrement (appuyez sur la touche A).
Remarque : lorsque l’enregistrement est activé, tous les champs correspondant 
à des paramètres que vous pouvez animer avec des images clés apparaissent dans 
une certaine teinte. Il s’agit de vous rappeler que la moindre modification apportée 
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3 Déplacez la tête de lecture vers la position à laquelle vous souhaitez créer une image 
clé, puis tapez une valeur dans le champ Vitesse personnalisée.
Par exemple, une valeur de 90 déplace l’objet à 90 % de la trajectoire d’animation.
4 Continuez de déplacer la tête de lecture et d’ajouter des images clés afin d’obtenir 
le résultat souhaité.
Remarque : si vous remplacez le paramètre Vitesse par un préréglage (tel que Constante) après avoir créé une vitesse personnalisée, le canal de vitesse personnalisée est 
ignoré, mais il reste intact.
Comportements connexes
« Gravité, » « Animation aléatoire, » « Lancer, » « Vent »
Modification d’une trajectoire d’animation dans un espace 3D
Vous pouvez modifier une trajectoire d’animation dans un espace 3D. Pour ce faire, 
la méthode la plus simple consiste à ajouter une caméra à votre projet, puis à manipuler 
la trajectoire dans une présentation de la caméra modifiée.
Pour modifier une trajectoire d’animation dans un espace 3D:
1 Si votre projet ne contient aucune caméra, ajoutez une caméra en procédant de 
l’une des manières suivantes :
Â Cliquez sur Nouvelle caméra dans la barre d’outils.
Â Choisissez Objet > Nouvelle caméra (ou appuyez sur les touches Option + 
Commande + C).
Remarque : si aucun des groupes de votre projet n’est à l’heure actuelle en 3D, une 
zone de dialogue vous demande si vous souhaitez transformer vos groupes 2D en 3D. 
Cliquez sur Basculer en 3D pour permettre à la caméra d’avoir un effet sur les groupes.
2 Procédez de l’une des manières suivantes :
Â Choisissez une présentation de caméra dans le menu Caméra, dans le coin supérieur 
gauche du Canevas (l’option par défaut est Caméra activée). Cet exemple utilise 
la vue d’en haut.
Â Après avoir sélectionné la présentation Caméra activée (ou une autre), utilisez l’outil 
Orbite (au centre, parmi les outils Présentation 3D, dans le coin supérieur droit 
du Canevas) pour faire pivoter la caméra.
Remarque : gardez à l’esprit qu’en utilisant les outils Présentation 3D alors qu’une 
caméra est sélectionnée, vous déplacez la caméra et pas seulement sa présentation.Chapitre 5 Utilisation des comportements 461
Selon la présentation de caméra choisie, il peut arriver que l’objet ne soit plus visible 
sur la trajectoire. Par exemple, si l’objet ne subit aucune rotation selon l’axe X ou Y 
et que vous travaillez en vue d’en haut, la caméra observe l’objet en vue plongeante, 
mais à la perpendiculaire (selon l’axe Y). Néanmoins, la trajectoire d’animation 
et ses points de contrôle restent visibles (dans la mesure où le comportement 
Trajectoire d’animation est sélectionné).
3 Faites glisser un point de contrôle vers le haut ou le bas pour le déplacer selon l’axe Z.
Remarque : les commandes à l’écran de la trajectoire d’animation sont disponibles 
pour toutes les présentations de caméra.
Si vous souhaitez indiquer des valeurs précises pour l’emplacement des points 
de contrôle, cliquez sur le triangle d’affichage en regard de Points de contrôle dans 
les paramètres du comportement Trajectoire d’animation. Les trois champs correspondent 
aux valeurs X, Y et Z.
Avant la transformation en 3D de la trajectoire 
d’animation, elle semble plate lorsque 
vous l’observez d’en haut. L’objet affecté ne 
se déplace que selon les axes X et Y.
Une fois les valeurs Z modifiées, la trajectoire 
n’est plus aplatie et l’objet affecté se déplace 
selon les axes X, Y et Z.462 Chapitre 5 Utilisation des comportements
4 Pour réinitialiser la présentation de la caméra, procédez de l’une des manières 
suivantes :
Â Double-cliquez sur l’outil Présentation 3D précédemment sélectionné. Par exemple, 
si vous avez utilisé l’outil Orbite pour faire pivoter la caméra en cours, double-cliquez 
sur le même outil pour réinitialiser la caméra.
Â Si vous avez sélectionné (et/ou modifié) une présentation de caméra par défaut 
(Haut, Droite, Gauche, etc.), choisissez Caméra activée dans le menu Caméra 
ou Présentation > Présentation 3D > Caméra activée.
Â Sélectionnez la caméra, puis cliquez sur le bouton Réinitialiser dans l’onglet 
Propriétés de l’Inspecteur.
Déplacer
Ce comportement positionne un point dans le Canevas qui correspond à un emplacement spécifique à partir duquel ou vers lequel un objet ou un groupe se déplace.
Dans l’illustration suivante, le comportement Vortex est appliqué à l’image centrale 
représentant des poissons, ce qui pousse l’image extérieure de la tortue à tourner 
autour en formant un cercle.
Dans les illustrations ci-dessous, un comportement Déplacer est appliqué à l’image 
de la tortue. La cible du comportement Déplacer (ou « objet zéro ») est positionnée 
au centre de l’image des poissons. Tout en tournant autour de l’image des poissons, 
l’image de la tortue est également attirée vers le centre.Chapitre 5 Utilisation des comportements 463
∏ Astuce : le comportement Déplacer constitue un outil idéal lorsque vous travaillez en 3D, 
car il vous permet de simuler les mouvements d’une caméra, sans utiliser la moindre 
caméra. Si vous l’appliquez, par exemple, à un groupe contenant plusieurs objets décalés 
selon l’axe Z, vous pouvez créer un mouvement ressemblant à un travelling.
Commandes disponibles dans la palette
La palette affiche un curseur pour fixer le degré d’influence, un menu local Direction 
pour indiquer si l’objet se déplace vers ou depuis le point zéro, ainsi qu’un menu local 
Vitesse pour déterminer la vitesse de déplacement de l’objet.
Paramètres dans l’Inspecteur
Position : champs vous permettant de définir les positions X, Y et Z du point cible. 
Par défaut, la cible du comportement Déplacer (ou « objet zéro ») est positionnée 
au centre du Canevas.
Remarque : vous devez sélectionner le comportement Déplacer et l’outil Ajuster 
l’élément de la barre d’outils pour pouvoir déplacer la cible. En revanche, utilisez l’outil 
Sélectionner/Transformer pour déplacer l’objet.
Force : curseur déterminant la vitesse à laquelle l’objet se déplace en direction 
de la cible. Dans le cas d’une valeur égale à 0, l’objet reste immobile. Plus la valeur 
indiquée est élevée, plus l’objet se déplace vite.
Direction : menu local qui définit si l’objet se déplace vers ou depuis le point cible.
Vitesse : menu local qui définit la vitesse de l’objet, depuis sa position dans le Canevas 
jusqu’à la position de la cible. Vous avez six choix possibles :
Â Constante : l’objet se déplace à vitesse constante, depuis sa position jusqu’à la cible.
Â Atténuation en entrée : l’objet démarre à une vitesse réduite, puis atteint et conserve 
une vitesse constante jusqu’à la cible.
Â Atténuation en sortie : l’objet commence à une vitesse constante, puis ralentit 
progressivement pour s’arrêter lorsqu’il atteint la cible.
Â Atténuation en entrée/sortie : l’objet accélère progressivement, pour ensuite 
ralentir graduellement et s’arrêter lorsqu’il atteint la cible.
Â Accélérer : la vitesse de déplacement de l’objet vers la cible est croissante.
Â Ralentir : la vitesse de déplacement de l’objet vers la cible est décroissante.
Remarque : pour que l’objet se déplace plus lentement vers la cible, augmentez 
la durée du comportement Déplacer dans la Timeline ou la mini-Timeline. À l’inverse, 
réduisez la durée de ce comportement pour qu’il se déplace plus rapidement.464 Chapitre 5 Utilisation des comportements
Pointer vers
Si vous appliquez un comportement Pointer vers à un objet ou à un groupe, vous pouvez 
indiquer un point cible en direction duquel l’objet ou le groupe affecté se tourne.
∏ Astuce : combinez les comportements Pointer vers et Déplacer pour créer des objets 
animés, qui non seulement se déplacent en direction d’un point (ou l’un vers l’autre), 
mais aussi se tournent vers cette cible.
Commandes disponibles dans la palette
La palette affiche un cadre d’objet, un curseur Transition, un menu local Vitesse pour 
définir la vitesse de déplacement de l’objet, un menu local Axe pour choisir quel axe 
doit pointer vers la cible une fois le déplacement terminé, ainsi qu’une case à cocher 
Inverser l’axe.
Paramètres dans l’Inspecteur
Objet : cadre permettant de définir l’objet cible. Pour ce faire, faites glisser l’objet de 
l’onglet Couches vers le cadre d’objet présent dans la palette Pointer vers ou l’Inspecteur. 
Vous pouvez également faire glisser l’objet cible sur le comportement Pointer vers dans 
l’onglet Couches.
Transition : curseur déterminant le temps nécessaire à l’objet pour passer de son 
orientation d’origine à sa position face au centre de l’objet cible. Ce paramètre est particulièrement utile lorsque l’objet pointe vers un objet cible en mouvement.
Si vous réglez le paramètre Transition à 50 % dans un projet contenant 300 images 
et que l’objet cible n’est pas en mouvement, l’objet affecté nécessite 150 images pour 
pointer vers (ou s’orienter vers) le centre de l’objet cible et il arrête de se déplacer sur 
le reste de la durée du comportement. À 100 %, le même objet a besoin des 300 images 
pour pointer vers l’objet cible. Si le comportement Pointer vers est d’une durée de 
100 images et le paramètre Transition réglé sur 50 %, l’objet affecté utilise 50 images 
pour s’orienter vers l’objet cible.
Si vous réglez le paramètre Transition à 50% dans un projet contenant 300 images 
et que l’objet cible est animé, l’objet affecté nécessite 150 images pour pointer vers 
(ou s’orienter vers) le centre de l’objet cible et il continue à suivre l’objet cible animé 
sur le reste de la durée du comportement. À 100 %, le même objet a besoin des 300 images 
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Vitesse : menu local qui définit la vitesse de l’objet, depuis sa position dans le Canevas 
jusqu’à la position de la cible. Vous avez six choix possibles :
Â Constante : l’objet se déplace à vitesse constante, depuis sa position jusqu’à la cible.
Â Atténuation en entrée : l’objet démarre à une vitesse réduite, puis atteint et conserve 
une vitesse constante jusqu’à la cible.
Â Atténuation en sortie : l’objet commence à une vitesse constante, puis ralentit 
progressivement pour s’arrêter lorsqu’il atteint la cible.
Â Atténuation en entrée/sortie : l’objet accélère progressivement, pour ensuite 
ralentir graduellement et s’arrêter lorsqu’il atteint la cible.
Â Accélérer : la vitesse de déplacement de l’objet vers la cible est croissante.
Â Ralentir : la vitesse de déplacement de l’objet vers la cible est décroissante.
Axe : menu local qui vous permet d’aligner la rotation de l’objet sur l’axe X, Y ou Z. 
Par défaut, il s’agit de l’axe Z. Ce paramètre précise quel axe pointe vers la cible une fois 
le mouvement terminé.
Inverser l’axe : si l’objet est aligné selon l’axe correct, mais qu’il semble se déplacer en 
marche arrière, cochez cette case pour le retourner et l’orienter dans la bonne direction.
Magnétiser l’alignement sur l’animation
Ce comportement aligne la rotation d’un objet de telle sorte qu’elle corresponde à toutes 
les modifications apportées à sa position le long d’une trajectoire d’animation. Il est conçu 
pour être combiné à d’autres comportements qui animent la position d’un objet ou à 
une trajectoire animée avec des images clés créée par vos soins.
Par exemple, si vous appliquez le comportement Trajectoire d’animation à une image 
de poisson, vous pouvez ajouter le comportement Magnétiser l’alignement sur l’animation pour que le poisson regarde dans la direction dans laquelle il avance.
Avant Après, avec le comportement Magnétiser 
l’alignement sur l’animation appliqué à 
la flèche466 Chapitre 5 Utilisation des comportements
Commandes disponibles dans la palette
La palette affiche un menu local qui vous permet de contrôler l’axe autour duquel 
l’objet pivote, un autre menu local pour définir l’axe utilisé pour ajuster l’alignement 
de l’objet, ainsi qu’une case à cocher Inverser l’axe.
Paramètres dans l’Inspecteur
Axe de rotation : menu local qui vous permet de faire pivoter l’objet autour de l’axe X, 
Y ou Z. Vous pouvez également choisir Tout pour faire pivoter l’objet autour des trois axes. 
L’axe de rotation par défaut correspond à l’axe Z. L’option Tout utilise une direction 
d’accélération, telle que « vers le haut », pour un effet similaire à des montagnes russes.
Axe : menu local qui vous permet de préciser si l’objet doit s’aligner selon son axe 
horizontal ou vertical.
Inverser l’axe : si l’objet est aligné selon l’axe correct, mais qu’il semble se déplacer en 
marche arrière, cochez cette case pour le retourner et l’orienter dans la bonne direction.
Fin du décalage : curseur permettant de décaler (d’un certain nombre d’images) la fin 
de l’effet d’un comportement par rapport à la dernière image de sa position dans 
la Timeline. Si vous réglez, par exemple, le paramètre Fin du décalage sur 60, l’objet 
s’aligne effectivement sur la direction de la trajectoire jusqu’à 60 images avant la fin 
du comportement dans la Timeline.
Comportements connexes
« Aligner sur l’animation »
Rotation
Ce comportement vous permet d’animer la rotation d’un objet en le faisant pivoter 
autour d’un seul axe. Vous pouvez utiliser l’option Personnaliser de l’axe pour que 
la rotation ne s’effectue pas selon les axes habituels (X, Y ou Z). Si vous effectuez un Trim 
sur la fin du comportement Rotation et le rendez ainsi plus court que la durée de l’objet 
auquel il est appliqué, il reste dans l’angle de la dernière image du comportement, pour 
autant qu’aucun autre comportement ou image clé ne modifie le paramètre Rotation de 
cet objet.
Hormis les usages évidents de ce comportement, il peut également servir pour des objets 
dont le point d’ancrage n’est pas centré. Sachant que les objets pivotent autour de leur 
point d’ancrage, le repositionnement de ce point avant d’appliquer un comportement 
Rotation peut rapidement modifier l’aspect de l’animation que vous créez. Pour en savoir 
plus sur le changement du point d’ancrage d’un objet, voir « Modification du point 
d’ancrage d’un objet » à la page 305.Chapitre 5 Utilisation des comportements 467
Commandes disponibles dans la palette
La palette du comportement Rotation affiche des commandes graphiques représentant 
un cercle intérieur et extérieur. Faites glisser le pointeur le long du cercle extérieur pour 
manipuler une flèche qui indique la direction et la vitesse selon lesquelles l’objet pivote. 
Réglez la longueur de cette même flèche pour modifier la vitesse de rotation : il vous 
suffit de la faire tourner plusieurs fois autour pour augmenter la vitesse.
La flèche du cercle intérieur contrôle l’axe autour duquel l’objet ou le groupe pivote. 
Lorsque vous faites glisser cette commande intérieure, un globe apparaît pour vous 
permettre d’ajuster la rotation de l’objet en degrés de longitude et de latitude.
Remarque : faites tourner la flèche plusieurs fois autour du cercle pour que l’objet 
pivote plus rapidement.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez le comportement Rotation à un objet contenant plusieurs objets, comme un groupe, un émetteur 
de particules ou un texte. Si vous cochez cette case, chaque objet au sein de la couche 
ou du groupe pivote séparément. Dans le cas contraire, l’ensemble de la couche ou 
du groupe pivote.
Incrémentation : ce menu local permet de décider la progression de l’effet du 
comportement sur sa durée dans la Timeline. Il existe deux solutions possibles :
Â Pente continue : cette commande se sert du paramètre Vitesse de rotation 
pour faire pivoter l’objet d’un nombre constant de degrés par seconde.
Â Pente constante jusqu’à la valeur finale : cette commande fait pivoter l’objet 
du nombre de degrés indiqué dans le paramètre Faire pivoter de sur toute la durée 
du comportement dans la Timeline.
Commandes gérant le sens et la vitesse de la rotation.468 Chapitre 5 Utilisation des comportements
Vitesse de rotation/Faire pivoter de : cadran contrôlant la vitesse de rotation de l’objet. 
Si vous avez réglé le paramètre Incrémentation sur Pente continue, le paramètre Vitesse 
de rotation définit une vitesse de rotation constante en degrés par seconde. En revanche, 
si vous avez réglé le paramètre Incrémentation sur Pente constante jusqu’à la valeur 
finale, le paramètre Vitesse de rotation définit un nombre de degrés pour la rotation 
sur toute la durée de l’objet. Des valeurs négatives produisent une rotation dans le sens 
des aiguilles d’une montre, des valeurs positives une rotation dans le sens inverse.
Axe : menu local qui vous permet de choisir si l’objet doit pivoter autour de l’axe X, Y 
ou Z. Si vous sélectionnez l’option Personnaliser, les paramètres complémentaires 
Longitude et Latitude apparaissent.
Lorsque le paramètre Axe est réglé sur Personnaliser, les paramètres Longitude et Latitude 
deviennent disponibles. Ils vous permettent de faire pivoter l’objet selon un certain angle 
(sans le verrouiller par rapport à l’axe X, Y ou Z).
.
Comportement Rotation 
avec le paramètre Axe par 
défaut, à savoir l’axe Z
Paramètre Axe réglé sur X Paramètre Axe réglé sur Y
Faites glisser la commande de l’axe vers 
le centre du cercle pour modifier la latitude 
et la longitude de la rotation.Chapitre 5 Utilisation des comportements 469
L’illustration suivante met en évidence l’utilisation des paramètres Longitude et Latitude.
Latitude/Longitude : disponibles uniquement si le paramètre Axe est réglé sur Personnaliser (ou si vous faites glisser la commande Centre de la palette Rotation), ces paramè-
tres vous permettent de définir l’axe de rotation.
Lancer
Ce comportement représente sans aucun doute la méthode la plus simple pour animer 
un objet. Des commandes vous permettent de régler la vitesse et la direction d’une force 
exercée sur l’objet au niveau de la première image du comportement. Suite à l’application de cette force initiale, l’objet continue à dériver à la même vitesse selon une ligne 
droite, pendant toute la durée du comportement Lancer. 
À titre d’exemple simple, le comportement Lancer peut vous servir à envoyer une série 
d’objets actuellement hors écran de telle sorte qu’ils viennent traverser l’écran. Si vous 
le combinez avec d’autres comportements, tels que Grossir/Rétrécir et Fondu entrant/
sortant, vous pouvez obtenir des éléments en mouvement sophistiqués, sans avoir à 
animer le moindre paramètre avec des images clés.
Le comportement Lancer est également utile lorsque vous déplacez un objet dans 
une simulation. Vous pouvez, par exemple, faire passer l’objet au-delà d’autres objets 
auxquels sont appliqués les comportements Attracteur ou Repousser. Comme le comportement Lancer applique une force unique à l’objet cible pour le déplacer à partir 
de la première image du comportement, tout autre comportement en interaction avec 
cet objet cible peut avoir un impact considérable sur son animation.
Important : la force exercée n’est pas continue et il est impossible de changer le sens 
ou la vitesse, car ce comportement ne peut pas être animé avec des images clés. 
Pour ce type de modification, servez-vous du comportement Vent. Pour créer une trajectoire d’animation plus complexe, utilisez le comportement Trajectoire d’animation.
Latitude
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Commandes disponibles dans la palette
La palette 2D vous permet de préciser la direction et la vitesse du comportement Lancer 
en faisant glisser une flèche à l’intérieur d’une zone circulaire. Le sens de la flèche 
détermine la direction du mouvement selon les axes X et Y, alors que sa longueur définit la vitesse. Un curseur situé à droite vous permet de déterminer l’échelle 
des commandes de direction/vitesse disponibles dans la palette, ce qui augmente 
ou diminue leur effet sur l’objet.
Si vous cliquez sur le bouton 3D, la palette affiche des commandes supplémentaires. 
Le flèche centrale définit désormais la direction dans laquelle l’objet est lancé en espace 
tridimensionnel (selon les axes X, Y et Z). Le curseur Vitesse (à gauche de la palette) vous 
permet alors d’augmenter ou de réduire la vitesse à laquelle l’objet est lancé.
Dans les palettes du comportement Lancer 2D et 3D, maintenez la touche Maj 
enfoncée alors que vous faites glisser la flèche pour la déplacer selon des angles 
de 45 degrés. Dans la palette 2D, appuyez sur la touche Commande pour changer 
le sens de la flèche sans modifier sa longueur.
Remarque : la vitesse maximale qu’il vous est possible de fixer dans la palette 
ne correspond pas à la vitesse maximale autorisée. Vous pouvez en effet saisir 
des valeurs plus élevées dans le paramètre Incrémentation dans l’onglet 
Comportements de l’Inspecteur.
Contrôle la direction et la vitesse du comportement Lancer.
Fixe l’échelle des commandes de 
direction et de vitesse.
Réglage de la vitesse
du lancer.
Réglage de la direction
du lancer selon
les axes X, Y et Z.Chapitre 5 Utilisation des comportements 471
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez le comportement 
Lancer à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules 
ou un texte. Si vous cochez cette case, chaque objet au sein du groupe parent se déplace 
séparément. Dans le cas contraire, l’ensemble de la couche ou du groupe se déplace.
Incrémentation : ce menu local permet de décider la progression de l’effet du comportement sur sa durée dans la Timeline. Il existe deux solutions possibles :
Â Pente continue : cette commande fixe la vitesse de l’objet à un nombre constant 
de pixels par seconde, indiqué dans le paramètre Vitesse de lancement.
Remarque : si le Canevas affiche une image aux pixels non carrés, la vitesse verticale 
est exprimée en pixels par seconde, la vitesse horizontale étant un équivalent perçu.
Â Pente constante jusqu’à la valeur finale : cette commande déplace l’objet de 
sa position d’origine à la distance indiquée (en pixels) dans le paramètre Distance 
de lancement.
Vitesse de lancement/Distance de lancement : si vous sélectionnez l’option Pente 
continue dans le menu local Incrémentation, le paramètre Vitesse de lancement apparaît 
et vous permet de fixer une vitesse constante de déplacement de l’objet selon l’axe X, Y 
ou Z. En revanche, si vous choisissez l’option Pente constante jusqu’à la valeur finale, 
c’est le paramètre Distance de lancement qui apparaît et détermine la distance totale 
(en pixels) du déplacement de l’objet selon les axes X, Y et Z sur toute sa durée. Ce curseur 
est limité à 100 pixels. Utilisez le champ pour saisir des valeurs supérieures à 100.
Comportements connexes
« Trajectoire d’animation, » « Gravité, » « Animation aléatoire, » « Vent »
Comportements Paramètre
Ces comportements s’appliquent à tous les paramètres d’un objet qu’il est possible d’animer. Leurs effets se limitent au paramètre affecté. Il est possible d’ajouter le même comportement de paramètre à différents paramètres, ce qui produit des effets totalement 
distincts. Par exemple, vous pouvez appliquer le comportement Osciller au paramètre 
Opacité d’un objet pour le doter d’un fondu entrant et sortant ou à son paramètre Rotation pour le faire pivoter dans un sens et dans l’autre. Ces comportements de paramètre 
peuvent également s’appliquer à des paramètres de filtres, de générateurs, de systèmes 
de particules, voire d’autres comportements. Il s’agit par exemple de Osciller, Rendre aléatoire et Inverser.472 Chapitre 5 Utilisation des comportements
Pour en savoir plus sur l’application des comportements Paramètre, voir « Application 
de comportements Paramètre » à la page 417.
Audio
Ce comportement vous permet d’animer la quasi-totalité des paramètres en se basant 
sur les propriétés d’un fichier audio, telles que la fréquence des basses. Par exemple, 
vous pouvez appliquer le comportement Audio au paramètre Échelle d’un objet pour 
l’agrandir ou le réduire en fonction de l’amplitude de la basse ou à son paramètre Opacité 
pour le doter d’un fondu entrant et sortant sur le rythme. Pour en savoir plus sur l’utilisation du comportement de paramètre Audio, voir « Comportement de Paramètre 
Audio » à la page 1229.
Moyenne
Ce comportement adoucit la transition entre deux valeurs causée par les images clés 
et les comportements appliqués à un paramètre. Servez-vous par conséquent du comportement Moyenne pour adoucir des effets animés. Dans ce cas, l’animation est plus 
fluide et les modifications apportées à des paramètres tels qu’Opacité ou à des paramètres 
de filtres semblent se produire de façon plus graduelle. Utilisez le paramètre Taille de 
fenêtre pour déterminer dans quelle mesure le paramètre modifié doit être adouci.
∏ Conseil : le comportement Moyenne peut vous servir à lisser la séquence de valeurs 
générée par un comportement Rendre aléatoire.
Commandes disponibles dans la palette
La palette permet d’ajuster le paramètre Taille de fenêtre et de changer l’affectation 
des paramètres.
Paramètres dans l’Inspecteur
Taille de fenêtre : un curseur permet de définir dans quelle mesure le paramètre modifié 
doit être adouci en indiquant le nombre d’images adjacentes dont il faut faire la moyenne. 
Des valeurs élevées produisent un adoucissement supérieur en faisant la moyenne d’une 
plage plus importante de valeurs, ce qui rend l’animation plus fluide. Des valeurs faibles font 
la moyenne d’une plage de valeurs réduite et donnent un adoucissement moindre avec des 
valeurs plus proches de l’original.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Annuler, » « Inverser »
Exemples d’utilisation de comportements Paramètre
Pour prendre connaissance d’exemples d’utilisation de certains des comportements 
Paramètre, voir « Exemples de comportements » à la page 528.Chapitre 5 Utilisation des comportements 473
Attacher
Ce comportement vous permet de définir la valeur minimale et maximale d’un paramètre 
animé. Dans l’illustration suivante, un comportement Vortex est appliqué à l’image 
du milieu. Les images extérieures tournent autour de l’image centrale, comme indiqué 
par les trajectoires d’animation tracées en rouge.
Dans l’illustration suivante, un comportement Attacher est appliqué au paramètre 
Position X de l’image du haut. Les valeurs Maxi et Mini sont respectivement réglées 
sur 230 et 0.
Vous remarquez que la trajectoire d’animation circulaire est en fait coupée en deux. 
Si vous saisissez une valeur négative dans le champ Mini, l’image se déplace au-delà 
du point 0.
Commandes disponibles dans la palette
La palette vous permet de régler les valeurs Mini, Maxi et Mini et Maxi du comportement, 
ainsi que de changer l’affectation des paramètres.
Les lignes rouges indiquent les trajectoires 
d’animation des images extérieures.
La trajectoire d’animation de l’image du haut 
montre que cette image parcourt 230 pixels vers 
la droite, mais ne se déplace pas vers la gauche 
au-delà du point 0, ce qui provoque une animation semi-circulaire.474 Chapitre 5 Utilisation des comportements
Paramètres dans l’Inspecteur
Limiter à : menu local vous permettant de choisir à quelle(s) valeur(s) du paramètre 
associer le comportement Attacher. Vous avez le choix entre Mini, Maxi ou Mini et Maxi.
Mini : curseur de valeur vous permettant de fixer un taux minimal de modification 
pour un paramètre animé.
Maxi : curseur de valeur vous permettant de fixer un taux maximal de modification 
pour un paramètre animé.
Cette valeur est exprimée en pourcentage, en pixels ou en degrés selon le paramètre 
affecté. Ainsi, si vous appliquez le comportement Attacher au paramètre Rotation, 
les valeurs Mini et Maxi sont exprimées en degrés. En revanche, si vous l’appliquez 
au paramètre Position X, ces valeurs sont en pixels.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Quantifier »
Personnaliser
Ce comportement vous permet de créer des comportements personnalisés à l’aide 
d’un ensemble de paramètres qui sont ensuite animés avec des images clés pour obtenir le type d’animation que vous souhaitez appliquer à un objet. En enregistrant des 
comportements personnalisés dans la Bibliothèque, vous pouvez créer une collection 
de comportements répondant à vos besoins.
Avant de créer un comportement personnalisé, vous devez tout d’abord ajouter un 
comportement Personnaliser à un objet dans le Canevas. Dans Motion, le comportement 
Personnaliser est ajouté à un objet comme tout autre comportement, à l’exception 
des comportements Paramètre.
Remarque : bien que le comportement Personnaliser soit un comportement Paramètre, 
il n’apparaît pas dans la liste lorsque vous cliquez sur un paramètre tout en maintenant 
la touche Contrôle enfoncée.
Pour ajouter un comportement Personnaliser à un objet, procédez de l’une 
des manières suivantes :
m Sélectionnez l’objet auquel vous souhaitez ajouter un comportement Personnaliser, 
cliquez sur l’icône Ajouter comportement dans la barre d’outils, puis choisissez 
Paramètre > Personnaliser dans le menu local.
m Dans la Bibliothèque, sélectionnez la catégorie Comportements, la sous-catégorie 
Paramètre, puis faites glisser l’icône Personnaliser sur l’objet dans le Canevas, l’onglet 
Couches ou la Timeline.
Le comportement Personnaliser est alors appliqué à l’objet. Il n’a aucun effet tant que 
vous ne lui avez pas ajouté un paramètre.Chapitre 5 Utilisation des comportements 475
Pour ajouter un paramètre à animer dans un comportement Personnaliser :
m Dans le menu local Ajouter un paramètre, choisissez un paramètre à ajouter à la liste de 
paramètres Personnaliser. Ce menu contient tous les paramètres pouvant être animés.
Le paramètre apparaît dans l’onglet Comportements, sous le comportement Personnaliser. 
Une fois tous les paramètres à animer ajoutés au comportement Personnaliser, vous 
pouvez les animer avec des images clés dans l’Éditeur d’images clés pour obtenir l’effet 
animé recherché. Pour en savoir plus sur la manière d’animer des paramètres avec des 
images clés pour créer des animations, voir « Animation de comportements » à la 
page 559.
Pour supprimer un paramètre de la liste de paramètres Personnaliser :
m Choisissez le paramètre à supprimer dans la liste Supprimer le paramètre.
Ce paramètre disparaît alors de la liste de paramètres Personnaliser. Toutes les images 
clés qui étaient appliquées à ce paramètre sont également supprimées.
Une fois tous les paramètres ajoutés animés, vous pouvez enregistrer le comportement Personnaliser dans la Bibliothèque en vue d’un usage ultérieur. Pour en savoir 
plus sur l’enregistrement de comportements Personnaliser dans la Bibliothèque, 
voir « Enregistrement et partage de comportements personnalisés » à la page 442.
Le nouveau paramètre 
apparaît ici.476 Chapitre 5 Utilisation des comportements
Si vous appliquez un comportement Personnaliser précédemment enregistré dans 
la Bibliothèque à un objet d’un de vos projets, son animation avec des images clés 
est adaptée à la durée de l’objet auquel il est appliqué. Quelle que soit la durée du comportement Personnaliser d’origine, vous pouvez donc l’appliquer à n’importe quel objet, 
car son effet animé accélère ou ralentit pour s’adapter à la durée du nouvel objet.
Commandes disponibles dans la palette
La palette n’affiche aucune commande pour ce comportement.
Paramètres dans l’Inspecteur
Contrairement aux autres comportements, le comportement Personnaliser ne possède à 
l’origine aucun paramètre dans l’onglet Comportements. À la place, deux menus locaux 
permettent d’ajouter et de supprimer les paramètres de votre choix.
Ajouter un paramètre : ce menu local permet d’ajouter des paramètres à animer 
avec des images clés pour créer une animation personnalisée. Choisissez un paramètre 
dans ce menu pour l’ajouter à la liste de paramètres Personnaliser pour l’animer avec 
des images clés.
Supprimer le paramètre : ce menu local répertorie tous les paramètres ajoutés au 
comportement Personnaliser en cours. Choisissez-en un pour le supprimer de la liste 
de paramètres Personnaliser avec les images clés qui lui sont appliquées.
Exponentiel
Ce comportement vous permet de créer des animations plus naturelles lors de la mise 
à l’échelle des objets, tout spécialement si vous recourez à des valeurs importantes. 
Lorsqu’un objet passe, par exemple, d’une échelle toute petite à une très grande échelle, 
l’animation semble ralentir au moment où l’objet atteint les valeurs d’échelle les plus 
élevées. Le comportement Exponentiel fonctionne de façon similaire au comportement 
Pente, mais il applique une fonction mathématique pour créer une courbe exponentielle 
(au lieu d’une courbe linéaire) entre les deux valeurs. L’animation progresse ainsi lentement lorsque les valeurs d’échelle sont petites, puis accélère au fur et à mesure que ces 
valeurs augmentent. 
∏ Astuce : lorsqu’il est appliqué à d’autres paramètres qu’Échelle, le comportement Exponentiel génère des animations plus naturelles qu’avec les autres modes d’interpolation.
Vous pouvez également modifier les modes d’interpolation des images clés et les réglez 
sur Exponentielle. Pour en savoir plus, voir « Modification des courbes » à la page 595.Chapitre 5 Utilisation des comportements 477
Commandes disponibles dans la palette
La palette vous permet de définir les valeurs initiale et finale, ainsi que de changer 
l’affectation des paramètres.
Paramètres dans l’Inspecteur
Valeur initiale : valeur ajoutée au paramètre au niveau de la première image 
du comportement Exponentiel.
Valeur finale : valeur atteinte par le comportement Exponentiel au niveau de sa dernière 
image. Sur toute la durée du comportement, le paramètre auquel il est appliqué crée 
une transition entre la Valeur initiale et la Valeur finale, plus la valeur d’origine.
Début du décalage : curseur permettant de retarder le début de l’effet d’un comportement par rapport à la première image de sa position dans la Timeline. Réglez ce paramè-
tre pour que le comportement commence plus tard. Sa valeur est exprimée en images.
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement 
par rapport à la dernière image de sa position dans la Timeline, en images. Réglez 
ce paramètre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. 
Si vous utilisez ce curseur pour arrêter l’effet, au lieu d’effectuer un Trim sur la fin 
du comportement dans la Timeline, vous pouvez bloquer l’effet du comportement 
sur l’objet pour le temps restant. Le Trim sur la fin du comportement restaure la valeur 
d’origine du paramètre de l’objet.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Logarithmique, » « Pente »
Logarithmique
Le comportement Logarithmique est l’inverse du comportement de paramètre Exponentiel. Tout comme le comportement Exponentiel, il vous permet de créer des animations plus naturelles lors de la mise à l’échelle des objets, tout spécialement si vous 
recourez à des valeurs importantes. Cependant, il applique une fonction mathématique pour créer une courbe logarithmique (au lieu d’une courbe linéaire) entre les deux 
valeurs, dont l’effet augmente rapidement, puis ralentit. L’animation progresse ainsi 
lentement lorsque les valeurs d’échelle sont petites, puis accélère au fur et à mesure 
que ces valeurs augmentent.
Vous pouvez appliquer le comportement Logarithmique à des paramètres déjà animés 
à l’aide de comportements ou d’images clés, mais il n’aura aucun impact sur ces paramètres tant que leurs valeurs initiales et finales ne seront pas différentes de zéro.478 Chapitre 5 Utilisation des comportements
∏ Astuce : lorsqu’il est appliqué à d’autres paramètres que Échelle, le comportement 
Logarithmique génère des animations plus naturelles qu’avec les autres modes 
d’interpolation.
Remarque : vous pouvez également modifier les modes d’interpolation des images clés 
et les réglez sur Logarithmique. Pour en savoir plus, voir « Modification des courbes » à 
la page 595.
Commandes disponibles dans la palette
La palette vous permet de définir les valeurs initiale et finale, ainsi que de changer 
l’affectation des paramètres.
Paramètres dans l’Inspecteur
Valeur initiale : valeur ajoutée au paramètre au niveau de la première image 
du comportement Logarithmique.
Valeur finale : valeur atteinte par le comportement Logarithmique au niveau de 
sa dernière image. Sur toute la durée du comportement, le paramètre auquel il est 
appliqué crée une transition entre la Valeur initiale et la Valeur finale, plus la valeur 
d’origine.
Début du décalage : curseur permettant de retarder le début de l’effet d’un comportement par rapport à la première image de sa position dans la Timeline. Réglez ce paramè-
tre pour que le comportement commence plus tard. Sa valeur est exprimée en images.
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement 
par rapport à la dernière image de sa position dans la Timeline, en images. Réglez 
ce paramètre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. 
Si vous utilisez ce curseur pour arrêter l’effet, au lieu d’effectuer un Trim sur la fin 
du comportement dans la Timeline, vous pouvez bloquer l’effet du comportement 
sur l’objet pour le temps restant. Le Trim sur la fin du comportement restaure la valeur 
d’origine du paramètre de l’objet.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Exponentiel, » « Pente »
MIDI
Ce comportement vous permet de modifier et d’animer des paramètres d’objet à l’aide 
de périphériques MIDI standard, tels qu’un synthétiseur. Pour le mélangeur graphique 
d’animation réelle.Chapitre 5 Utilisation des comportements 479
Commandes disponibles dans la palette
La palette met à votre disposition les commandes Type de commande, ID, Valeur, 
Échelle et vous permet de modifier l’affectation des paramètres.
Paramètres dans l’Inspecteur
Type de commande : spécifie le mode du contrôleur MIDI. Les trois types de commande 
disponibles sont les suivants :
Â Remarque : ce mode s’affiche lorsque le contrôle est une touche du clavier sur 
le périphérique MIDI.
Â Contrôleur : ce mode s’affiche lorsque la commande est un bouton, un cadran, 
une touche, un curseur ou une pédale sur le périphérique MIDI.
Â Apprentissage : ce mode est utilisé pour « apprendre » à Motion la commande 
(bouton, cadran, touche, etc.) que vous souhaitez utiliser sur le périphérique MIDI 
pour manipuler le paramètre auquel le comportement MIDI est appliqué. En mode 
Apprentissage, le premier bouton, le premier cadran ou la première touche que vous 
ajustez sur le périphérique MIDI est défini comme commande.
Remarque : lors de la première application du comportement MIDI, Apprentissage 
est le type de commande par défaut.
ID : affiche le numéro d’identification du contrôle MIDI (tel qu’un bouton, un cadran 
ou une touche) que vous manipulez.
Valeur : lors de la manipulation de la commande, affiche la valeur MIDI standard 
entre 0 et 1.
Échelle : l’augmentation de la valeur Échelle multiplie le paramètre Valeur dans le comportement MIDI. Cela signifie que lorsque la valeur Échelle est augmentée, la commande 
MIDI présente une plage de valeurs plus importante et un effet supérieur sur le paramè-
tre contrôlé. Par exemple, lors de l’utilisation d’un bouton pour ajuster la rotation d’un 
objet, la plage de valeurs de rotation par défaut (lorsque le paramètre Échelle est réglé 
sur 1) pour un tour complet du bouton peut être seulement de 30 pour cent. Lorsque 
la valeur Échelle est portée à 13, la valeur de rotation pour un tour complet du bouton 
passe alors à 370 degrés.
Appliquer à : le menu local Appliquer à (« Aller », commande d’affectation de paramètre) 
montre le paramètre modifié et sert à réattribuer le comportement à un autre paramètre.
Le comportement MIDI est appliqué de la même façon que tous les autres comportements Paramètre. Dans les exemples suivants, le comportement MIDI est utilisé pour 
ajuster l’opacité et la rotation d’un objet.
Remarque : ce comportement peut uniquement être utilisé si un périphérique MIDI 
est correctement connecté à votre ordinateur.480 Chapitre 5 Utilisation des comportements
Pour utiliser le comportement de paramètre MIDI afin d’ajuster l’opacité d’un objet :
1 Sélectionnez un objet, puis choisissez le paramètre Opacité dans l’onglet Propriétés 
de l’Inspecteur.
2 Appuyez sur la touche Contrôle en cliquant sur le paramètre, puis sélectionnez MIDI 
dans le menu contextuel.
Les paramètres MIDI sont affichés dans l’onglet Comportements. Par défaut, Type de 
commande est défini sur Apprentissage.
Comme pour tous les autres comportements de paramètre, le champ Appliquer à affiche 
le paramètre auquel le comportement est appliqué.
3 Sur votre périphérique MIDI, ajustez la commande (bouton, cadran, touche, etc.) 
que vous souhaitez utiliser comme commande pour le paramètre Opacité.
Remarque : en mode Apprentissage, la première commande ajustée sur le périphérique 
MIDI est définie comme commande. Pour réinitialiser le contrôleur sélectionné, choisissez 
Apprentissage dans le menu local Type de commande, puis ajustez une autre commande 
sur le périphérique MIDI.
Le numéro d’identification de la commande MIDI est affiché dans le champ ID. La plage 
de valeurs de la commande est comprise entre 0 et 127, la valeur de commande MIDI 
par défaut.
Comme l’opacité d’un objet peut uniquement être comprise entre 0 (totalement transparent) et 100 (totalement opaque), les valeurs MIDI par défaut sont suffisantes pour 
ajuster ce paramètre.
Pour utiliser le comportement de paramètre MIDI afin d’ajuster la rotation d’un objet :
1 Sélectionnez un objet, puis choisissez le paramètre Rotation dans l’onglet Propriétés 
de l’Inspecteur.
2 Appuyez sur la touche Contrôle en cliquant sur le paramètre, puis sélectionnez MIDI 
dans le menu contextuel.
3 Sur votre périphérique MIDI, ajustez la commande (bouton, cadran, touche, etc.) 
que vous souhaitez utiliser comme contrôleur pour le paramètre Rotation.
Comme précédemment indiqué, la plage de valeurs par défaut est comprise entre 0 et 1. 
La valeur Rotation d’un objet pouvant être beaucoup plus élevée, utilisez le paramètre 
Échelle pour multiplier cette plage de valeurs.
4 Pour augmenter la sensibilité de la commande, augmentez la valeur Échelle.Chapitre 5 Utilisation des comportements 481
Annuler
Ce comportement inverse la valeur de chaque effet d’image clé et de comportement 
en multipliant le paramètre concerné par –1. Concrètement, il prend la valeur opposée 
de chaque paramètre. Les trajectoires d’animation sont inversées, tout comme la rotation, 
et tout paramètre d’effet adopte la valeur contraire.
Par exemple, si vous appliquez le comportement Annuler au paramètre Position 
d’un objet doté d’une trajectoire d’animation, cette dernière se déplace dans 
le quadrant opposé du Canevas.
Remarque : pour inverser l’animation dans une trajectoire, au lieu de retourner la forme 
de cette dernière, utilisez le comportement de paramètre Inverser.
Commandes disponibles dans la palette
La palette vous permet de changer l’affectation des paramètres.
Paramètres dans l’Inspecteur
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Moyenne, » « Inverser »
Osciller
Ce comportement anime un paramètre en le faisant basculer indéfiniment entre deux 
valeurs différentes. Vous pouvez définir l’écart entre ces valeurs, ainsi que le nombre 
d’oscillations par minute. Le comportement Osciller peut créer toutes sortes d’effets 
cycliques. Par exemple, si vous l’appliquez à la propriété de rotation d’un objet, ce dernier 
commence à se balancer d’un côté à l’autre. En effet, la propriété de rotation fait des 
va-et-vient entre la valeur de rotation d’origine plus et moins la valeur Amplitude définie dans le comportement Osciller. 482 Chapitre 5 Utilisation des comportements
D’un autre côté, si vous appliquez ce comportement à la valeur X du paramètre Échelle, 
la largeur de l’objet entame un mouvement cyclique, s’étirant et se compactant sans 
cesse sur toute la durée du comportement.
Le comportement Osciller fonctionnant par addition, la valeur qu’il génère est ajoutée 
à celle d’origine du paramètre auquel il est appliqué.
Commandes disponibles dans la palette
La palette met à votre disposition les paramètres Phase, Amplitude, Vitesse, Demi-plage 
et vous permet de modifier l’affectation des paramètres.
Paramètres dans l’Inspecteur
Forme d’onde : menu local vous permettant de choisir la forme de l’onde d’oscillation. 
Vous avez le choix entre : Sinus (par défaut), Carré, Dent de scie et Triangle.
Â Sinus : forme d’onde par défaut. Cette forme crée une animation lisse entre 
les valeurs. Si vous appliquez, par exemple, le comportement Osciller au paramètre 
Opacité d’un objet et que le paramètre Forme d’onde est réglé sur Sinus, l’objet 
est soumis à de gracieux fondus entrants et sortants.
Â Carré : l’onde de forme carrée crée des changements de valeurs abrupts. Si vous 
appliquez, par exemple, le comportement Osciller au paramètre Opacité d’un objet 
et que le paramètre Forme d’onde est réglé sur Carré, l’objet clignote (comme si vous 
allumiez, puis éteigniez la lumière).Chapitre 5 Utilisation des comportements 483
Â Dent de scie : les ondes en forme de dents de scie atteignent leur point culminant 
au fil du temps, puis redescendent brutalement. Si vous appliquez, par exemple, 
le comportement Osciller au paramètre Opacité d’un objet et que le paramètre 
Forme d’onde est réglé sur Dent de scie, l’objet subit un fondu entrant graduel, puis 
un fondu sortant extrêmement rapide (comme si vous utilisiez un variateur d’intensité pour allumer graduellement une lumière, puis que vous la coupiez brutalement).
Â Triangle : similaire à la forme d’onde Sinus, une onde en forme de triangle crée une 
animation lisse entre les valeurs, mais avec des changements abrupts au moment des 
transitions. Si vous appliquez, par exemple, le comportement Osciller au paramètre 
Opacité d’un objet et que le paramètre Forme d’onde est réglé sur Triangle, l’objet 
est soumis à des fondus entrants et sortants plus rapides qu’avec la forme Sinus.
Phase : curseur permettant de déterminer le point d’oscillation auquel commence 
le comportement. Grâce à ce paramètre, vous pouvez désynchroniser plusieurs objets 
avec des comportements Osciller identiques pour qu’ils aient un aspect différent.
Amplitude : curseur permettant d’ajuster les valeurs maximales entre lesquelles 
le paramètre oscille. Le paramètre bascule entre la valeur d’amplitude et la valeur 
opposée. Des valeurs élevées augmentent l’intensité du basculement entre le début 
et la fin de chaque oscillation.484 Chapitre 5 Utilisation des comportements
Vitesse : curseur permettant de déterminer la vitesse à laquelle l’oscillation se produit, 
exprimée en oscillations par minute. Des valeurs élevées accélèrent les oscillations.
Demi-plage : si cette option est activée, l’onde en forme de sinus (ou toute autre forme 
d’onde) est en fait coupée en deux et ne va pas au-delà de la valeur 0. Par exemple, 
si vous réglez l’amplitude sur 100, le paramètre oscille entre les valeurs 100 et –100. 
En revanche, si l’option Demi-plage est activée, il oscille entre 100 et 0. Si l’amplitude 
est réglée sur –100, il oscille alors entre –100 et 0.
∏ Astuce : lorsque vous appliquez le comportement Osciller à des paramètres Position, 
réglez le paramètre Forme d’onde sur Sinus et cochez la case Demi-plage pour créer 
un effet de rebond.
Début du décalage : curseur permettant de retarder le début de l’effet d’un comportement par rapport à la première image de sa position dans la Timeline. Réglez ce paramè-
tre pour que le comportement commence plus tard. Sa valeur est exprimée en images.
La ligne en pointillés représente la valeur 0. 
Si l’option Demi-plage est désactivée, 
le paramètre oscille entre la valeur Amplitude et son opposé, comme 100 et –100.
La ligne en pointillés représente la valeur 0. 
Si l’option Demi-plage est activée, le paramètre oscille entre la valeur Amplitude et 0.Chapitre 5 Utilisation des comportements 485
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement par 
rapport à la dernière image de sa position dans la Timeline, en images. Réglez ce paramè-
tre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. Si vous utilisez 
ce curseur pour arrêter l’effet, au lieu d’effectuer un Trim sur la fin du comportement dans 
la Timeline, vous pouvez bloquer l’effet du comportement sur l’objet pour le temps restant. Le Trim sur la fin du comportement restaure les valeurs d’origine des paramètres de 
l’objet.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Pente, » « Vitesse »
Création d’une oscillation décroissante
Lorsque vous appliquez un comportement Osciller au paramètre Rotation ou Position 
d’un objet, vous êtes souvent amené à utiliser un effet de « chute » ou de « mouillage » 
sur l’animation au fil du temps. Autrement dit, vous faites en sorte que l’animation 
ralentisse graduellement, puis s’arrête. Pour ce faire, utilisez des images clés pour 
réduire progressivement l’amplitude de l’oscillation.
Pour appliquer une oscillation décroissante à une rotation à l’aide d’images clés :
1 Placez-vous sur l’image sur laquelle vous souhaitez que l’animation commence, 
puis activez l’enregistrement (ou appuyez sur A).
2 Définissez le paramètre Amplitude sur la valeur la plus élevée à utiliser dans votre projet.
Remarque : lorsque l’enregistrement est activé, toute modification apportée à la valeur 
d’un paramètre dans l’Inspecteur, la palette ou le Canevas crée une image clé.
3 Placez-vous sur l’image sur laquelle vous souhaitez que l’animation cesse et réglez 
le paramètre Amplitude sur 0.
Si vous avez sélectionné l’objet, vous visualisez la décroissance progressive de l’animation 
(due aux images clés associées au paramètre Amplitude) dans l’Éditeur d’images clés 
(si vous préalablement choisi Animé dans le menu local Afficher).486 Chapitre 5 Utilisation des comportements
Si vous avez sélectionné le comportement Osciller, vous visualisez la valeur des images 
clés associées au paramètre Amplitude dans l’Éditeur d’images clés (si vous préalablement choisi Animé dans le menu local Afficher).
Quantifier
Ce comportement vous permet de créer une animation incrémentielle à partir de tout 
paramètre qu’il est possible d’influencer avec des images clés ou des comportements. 
Par exemple, si le paramètre Opacité d’un objet est animé de telle sorte que ce dernier 
subisse un fondu entrant graduel au fil du temps, vous pouvez lui ajouter le comportement Quantifier pour que l’objet devienne opaque pas à pas.
Remarque : le comportement Quantifier ne fonctionne qu’avec les paramètres animés.
Commandes disponibles dans la palette
La palette vous permet d’ajuster les paramètres Taille du pas et Décalage, ainsi que 
de changer l’affectation des paramètres.
Paramètres dans l’Inspecteur
Taille du pas : curseur vous permettant de définir la taille des incréments, en vous 
basant sur les unités du paramètre auquel le comportement est appliqué. Ainsi, si vous 
appliquez Quantifier à un paramètre Rotation, les pas sont exprimés en degrés (même 
si la commande disponible n’est pas un cadran). Si vous l’appliquez à un paramètre 
Position, les pas sont exprimés en pixels.
La trajectoire d’animation tracée en rouge 
indique le parcours prévu d’une couche après 
l’application d’un comportement Lancer.
La même trajectoire d’animation une fois que 
les comportements Lancer et Quantifier sont 
appliqués. La valeur du pas est réglée sur 90.Chapitre 5 Utilisation des comportements 487
Décalage : curseur qui définit le décalage des pas. Si vous appliquez, par exemple, 
le comportement Quantifier au paramètre Position et que vous réglez Taille du pas 
sur 100, l’objet progresse par incréments limités à 100 pixels, ce qui implique que 
le décalage des pas est de 100, 200, 300, etc. Au lieu de quoi, si Décalage est réglé 
sur 50, les pas décalés sont limités à 50, 150, 250, etc.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Pente
Ce comportement permet de créer une transition graduelle dans tout paramètre pouvant 
être animé, entre la Valeur initiale et la Valeur finale. La vitesse de la transition est fixée 
par la longueur du comportement Pente dans la Timeline et par la valeur finale du comportement. D’autres paramètres permettent de définir le déroulement de la transition, 
qu’il s’agisse d’une seule vitesse constante ou d’une accélération au cours du temps.
Il s’agit d’un comportement polyvalent. Si vous l’appliquez à la propriété Échelle, 
il fonctionne comme le comportement Grossir/Rétrécir. En revanche, si vous l’appliquez 
à la propriété Opacité, il donne à un objet divers types de fondus entrants ou sortants. 
Il peut non seulement servir à imiter d’autres comportements de Motion, mais aussi 
être appliqué à n’importe quel paramètre.
Remarque : ce comportement fonctionnant par addition, la valeur qu’il génère est 
ajoutée à celle d’origine du paramètre auquel il est appliqué.
Imaginez par exemple l’animation de différents segments d’une image en forme de bande, 
chaque segment devant grossir jusqu’à atteindre une longueur donnée. (Conseil : vous 
pouvez alors affecter un masque soustractif à chaque objet de la bande, puis animer 
la position de chaque masque pour révéler lentement chaque bande au fil du temps.)488 Chapitre 5 Utilisation des comportements
Une fois les bandes configurées avec leur masque dans le Canevas, vous pouvez appliquer le comportement Pente aux valeurs X de chaque masque et déplacer ainsi facilement les masques vers le côté pour donner l’impression que les bandes grandissent. 
Il vous suffit de régler le paramètre Valeur finale de chaque comportement Pente sur 
la longueur que chaque bande doit atteindre.
Commandes disponibles dans la palette
La palette vous permet de définir les valeurs initiale et finale de la pente et sa courbure, 
ainsi que de changer l’affectation des paramètres.
Paramètres dans l’Inspecteur
Valeur initiale : valeur ajoutée au paramètre à la première image du comportement Pente.
Valeur finale : valeur atteinte par le comportement Pente à la dernière image du comportement. Sur la durée du comportement, le paramètre auquel il est appliqué crée 
une transition entre la Valeur initiale et la Valeur finale plus la valeur d’origine.
Courbure : ce paramètre permet de faciliter l’accélération des transitions du comportement Pente entre la Valeur initiale et la Valeur finale. Des valeurs de courbure élevées 
produisent un effet d’atténuation en entrée/sortie. En effet, la valeur commence lentement la transition pour accélérer de plus en plus au fil du comportement et ralentir 
à nouveau petit à petit jusqu’à la fin. La courbure ne modifie pas toute la durée 
de l’effet : celle-ci est définie par la longueur du comportement dans la Timeline.
Début du décalage : curseur permettant de retarder le début de l’effet d’un comportement par rapport à la première image de sa position dans la Timeline. Réglez ce paramè-
tre pour que le comportement commence plus tard. Sa valeur est exprimée en images.
Avant Après utilisation de comportements Pente pour 
déplacer les masquesChapitre 5 Utilisation des comportements 489
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement 
par rapport à la dernière image de sa position dans la Timeline, en images. Réglez 
ce paramètre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. 
Si vous utilisez ce curseur pour arrêter l’effet, au lieu d’effectuer un Trim sur la fin 
du comportement dans la Timeline, vous pouvez bloquer l’effet du comportement 
sur l’objet pour le temps restant. Le Trim sur la fin du comportement restaure la valeur 
d’origine du paramètre de l’objet.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Osciller, » « Vitesse »
Rendre aléatoire
Ce comportement crée une séquence continue de valeurs augmentant et diminuant de 
façon aléatoire, en fonction des paramètres déterminant la plage et le type de valeurs 
générées. 
Même si les valeurs créées avec ce comportement sont aléatoires, elles sont en fait pré-
définies par les réglages de paramètre que vous avez choisis. Tant que vous ne modifiez 
pas les paramètres, les valeurs image par image créées par ce comportement restent 
inchangées. Si les valeurs générées de façon aléatoire ne vous conviennent pas, cliquez 
sur le bouton Générer dans l’onglet Comportements de l’Inspecteur afin de choisir 
un nouveau nombre de valeurs aléatoires. Ce nombre sert alors à générer une nouvelle 
séquence de valeurs. 
Le paramètre Mode Appliquer détermine comment les valeurs générées par ce comportement sont combinées avec d’autres comportements et images clés modifiant le même 
paramètre. Vous disposez ainsi de plusieurs méthodes d’utilisation du comportement 
Rendre aléatoire afin de modifier les valeurs préétablies d’un paramètre.
Le comportement Rendre aléatoire s’avère utile pour créer des effets de scintillement, 
tels qu’une rotation saccadée, une opacité vacillante et d’autres effets requérant 
des changements rapides et variés au cours du temps, pour lesquels une animation 
avec des images clés serait trop longue. Ce comportement est modifiable avec d’autres 
comportements, tels que Moyenne et Annuler, afin d’exercer un contrôle accru sur 
les valeurs générées.
Commandes disponibles dans la palette
La palette met à votre disposition les commandes Quantité, Multiplicateur, Fréquence, 
Bruit, Lien (pour les paramètres multidimensionnels), Début du décalage, Fin du décalage et vous permet de changer l’affectation des paramètres.490 Chapitre 5 Utilisation des comportements
Paramètres dans l’Inspecteur
Quantité/Multiplicateur : ce paramètre est réglé sur Quantité lorsque Mode Appliquer 
est réglé sur Ajouter, Soustraire ou Ajouter et soustraire. En revanche, il est réglé sur 
Multiplicateur lorsque Mode Appliquer est réglé sur Multiplier. Il fixe la valeur maximum 
que le comportement Rendre aléatoire générera.
Mode Appliquer : menu local déterminant comment les valeurs générées par ce comportement sont combinées avec d’autres comportements et images clés modifiant 
le même paramètre. Vous disposez ainsi de plusieurs méthodes d’utilisation du comportement Rendre aléatoire afin de modifier les valeurs préétablies d’un paramètre. 
Les options sont Ajouter, Soustraire, Multiplier ou Ajouter et soustraire.
Fréquence : curseur permettant de définir la quantité de variation aléatoire par seconde. 
Des valeurs élevées entraînent des variations plus rapides, des valeurs basses des variations 
plus lentes.
Bruit : ajoute une autre incrustation de variation aléatoire à la Fréquence choisie. 
Des valeurs élevées entraînent des variations plus irrégulières dans le paramètre concerné.
Lien : ce paramètre apparaît lorsque vous appliquez ce comportement à un paramètre 
bidimensionnel (comme Échelle) ou à un paramètre tridimensionnel (comme Position) 
constitué de valeurs X, Y et/ou Z. Cochez cette case pour que l’effet du comportement 
soit proportionnel sur chaque valeur.
Affecter les sous-objets : ce paramètre n’apparaît que si vous appliquez le comportement 
Rendre aléatoire à un paramètre du comportement Réplicateur de séquence. Lorsque 
cette option est activée, chaque objet présente un comportement aléatoire différent. 
Lorsqu’elle est désactivée, chaque objet subit la même animation.
Valeur aléatoire : bouton permettant de choisir un nouveau nombre de valeurs aléatoires. 
Ce nombre sert à générer de façon aléatoire de nouvelles séquences de valeurs en fonction 
des autres paramètres de ce comportement.
Début du décalage : curseur permettant de retarder le début de l’effet d’un comportement par rapport à la première image de sa position dans la Timeline. Réglez ce paramè-
tre pour que le comportement commence plus tard. Sa valeur est exprimée en images.
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement 
par rapport à la dernière image de sa position dans la Timeline, en images. Réglez 
ce paramètre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. 
Si vous utilisez ce curseur pour arrêter l’effet, au lieu d’effectuer un Trim sur la fin 
du comportement dans la Timeline, vous pouvez bloquer la dernière valeur aléatoire 
générée par ce comportement sur toute la durée restante de l’objet. Le Trim sur la fin 
du comportement restaure la valeur d’origine du paramètre.
Comportements connexes
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Vitesse
Ce comportement augmente la valeur d’un paramètre au cours du temps, avec un taux 
d’augmentation fixé par le curseur de Vitesse. Contrairement au comportement Pente, 
il ne possède pas de valeur finale : il continue simplement à réduire ou à augmenter 
le paramètre auquel il est appliqué jusqu’au terme de celui-ci.
Remarque : pour réduire la valeur d’un paramètre au fil du temps, il vous suffit de saisir 
une valeur négative dans le paramètre Vitesse.
Commandes disponibles dans la palette
La palette vous permet d’ajuster les paramètres Vitesse et Courbure, ainsi que de changer 
l’affectation des paramètres.
Paramètres dans l’Inspecteur
Vitesse : curseur de valeur permettant de fixer un taux d’augmentation du paramètre 
concerné sur la durée. La valeur est exprimée en pourcentage d’augmentation par seconde.
Courbure : ce paramètre permet de faciliter l’accélération des transitions du comportement Vitesse entre la Valeur initiale et la Valeur finale. Des valeurs de courbure élevées 
produisent un effet d’atténuation en entrée/sortie. En effet, la valeur commence lentement la transition pour accélérer de plus en plus au fil du comportement et ralentir à 
nouveau petit à petit jusqu’à la fin. La courbure ne modifie pas toute la durée de l’effet : 
celle-ci est définie par la longueur du comportement dans la Timeline.
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement par 
rapport à la dernière image de sa position dans la Timeline, en images. Réglez ce paramè-
tre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. Si vous utilisez 
ce curseur pour arrêter l’effet, au lieu d’effectuer un Trim sur la fin du comportement dans 
la Timeline, vous pouvez bloquer la dernière valeur aléatoire générée par ce comportement sur toute la durée restante de l’objet. Le Trim sur la fin du comportement restaure 
la valeur d’origine du paramètre.
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Osciller, » « Pente »492 Chapitre 5 Utilisation des comportements
Inverser
Contrairement au comportement Annuler, qui inverse la valeur du paramètre concerné, 
le paramètre Inverser inverse le sens de toute animation modifiant un paramètre, 
qu’elle soit générée par des comportements ou par des images clés. Par exemple, 
si vous appliquez le comportement Inverser à une trajectoire d’animation allant de 
gauche à droite, cette trajectoire ne bouge pas, mais l’objet commence son trajet à 
droite pour aller vers la gauche. En fait, ce comportement inverse les points de départ 
et de fin des objets animés.
Commandes disponibles dans la palette
La palette vous permet de changer l’affectation des paramètres.
Paramètres dans l’Inspecteur
Appliquer à : le menu local Appliquer à (« Aller ») montre le paramètre modifié et sert 
à réattribuer le comportement à un autre paramètre.
Comportements connexes
« Moyenne, » « Annuler »
Arrêter
Le comportement Arrêter interrompt l’animation d’un paramètre d’un objet (qu’elle soit 
due à des images clés ou à des comportements appliqués). Par exemple, si vous appliquez 
le comportement Arrêter au paramètre Position d’un objet qui se déplace sur l’écran 
et pivote, l’objet cesse de se déplacer sur l’écran, mais continue à pivoter.
L’effet de tous les comportements appliqués à l’objet est bloqué dès la première image 
du comportement Arrêter dans la Timeline. Les images clés appliquées à ce paramètre 
sont alors sans incidence pendant la durée du comportement Arrêter dans la Timeline.
Si le comportement Arrêter est plus court que l’objet auquel il est appliqué, l’ensemble 
des images clés et des comportements affectant ce canal sont immédiatement réactivés 
après la dernière image du comportement. Pour en savoir plus sur l’utilisation du comportement Arrêter, voir « Utilisation du comportement de paramètre Arrêter » à la page 430.
Commandes disponibles dans la palette
La palette vous permet de changer l’affectation des paramètres.
Paramètres dans l’Inspecteur
Appliquer à : le menu local Appliquer à (« Aller ») affiche le paramètre dont l’animation 
est interrompue et sert à réattribuer le comportement Arrêter à un autre paramètre.Chapitre 5 Utilisation des comportements 493
Suivre
Ce comportement vous permet d’appliquer des données de suivi à un paramètre particulier d’un effet, comme le point central du filtre Rayons de lumière. Pour en savoir plus 
sur l’utilisation du comportement Suivre, voir « Suivi de l’animation » dans le manuel 
PDF Documentation Supplémentaire de Motion.
Agiter
Ce comportement fonctionne comme le comportement Rendre aléatoire, mais avec 
un effet plus lent.
Commandes disponibles dans la palette
La palette met à votre disposition les commandes Quantité, Multiplicateur, Fréquence, 
Décalage de l’agitation, Bruit, Lien (pour les paramètres multidimensionnels), Début 
du décalage, Fin du décalage et vous permet de changer l’affectation des paramètres.
Paramètres dans l’Inspecteur
Quantité/Multiplicateur : ce paramètre est réglé sur Quantité lorsque Mode Appliquer 
est réglé sur Ajouter, Soustraire ou Ajouter et soustraire. En revanche, il est réglé sur 
Multiplicateur lorsque Mode Appliquer est réglé sur Multiplier. Il fixe la valeur maximale 
générée par le comportement Agiter.
Mode Appliquer : menu local déterminant comment les valeurs générées par ce comportement sont combinées avec d’autres comportements et images clés modifiant 
le même paramètre. Vous disposez ainsi de plusieurs méthodes d’utilisation du comportement Agiter afin de modifier les valeurs préétablies d’un paramètre. Les options 
sont Ajouter, Soustraire, Multiplier ou Ajouter et soustraire.
Fréquence : curseur permettant de définir la quantité de variation aléatoire par seconde. 
Des valeurs élevées entraînent des variations plus rapides, alors que des valeurs faibles 
sont à l’origine de variations plus lentes.
Décalage de l’agitation : curseur vous permettant de décaler la séquence des valeurs 
aléatoires lorsque vous souhaitez appliquer le même comportement Agiter à plusieurs 
objets. En décalant la version de chaque objet du comportement Agiter, vous pouvez 
les empêcher de se déplacer de façon synchronisée.
Bruit : curseur ajoutant une autre incrustation de variation aléatoire à la Fréquence choisie. 
Des valeurs élevées entraînent des variations plus irrégulières dans le paramètre concerné.
Lien : ce paramètre apparaît lorsque vous appliquez le comportement Agiter à 
un paramètre bidimensionnel (comme Échelle) ou à un paramètre tridimensionnel 
(comme Position) constitué de valeurs X, Y et/ou Z. Cochez cette case pour que l’effet 
du comportement soit proportionnel sur chaque valeur.494 Chapitre 5 Utilisation des comportements
Affecter les sous-objets : ce paramètre n’apparaît que si vous appliquez le comportement 
Agiter à un paramètre du comportement Réplicateur de séquence. Lorsque cette option 
est activée, chaque objet présente un comportement d’agitation différent. Lorsqu’elle 
est désactivée, chaque objet subit la même animation.
Valeur aléatoire : bouton permettant de choisir un nouveau nombre de valeurs aléatoires. 
Ce nombre sert à générer de façon aléatoire de nouvelles séquences de valeurs en fonction 
des autres paramètres de ce comportement.
Début du décalage : curseur permettant de retarder le début de l’effet d’un comportement par rapport à la première image de sa position dans la Timeline. Réglez ce paramètre 
pour que le comportement commence plus tard. La valeur de ce paramètre est exprimée 
en images.
Fin du décalage : curseur permettant de retarder la fin de l’effet d’un comportement 
par rapport à la dernière image de sa position dans la Timeline, en images. Réglez ce 
paramètre pour que le comportement s’arrête avant sa fin réelle dans la Timeline. 
Si vous utilisez ce curseur pour arrêter l’effet, au lieu d’effectuer un Trim sur la fin 
du comportement dans la Timeline, vous pouvez bloquer la dernière valeur aléatoire 
générée par ce comportement sur toute la durée restante de l’objet. Le Trim sur la fin 
du comportement restaure la valeur d’origine du paramètre.
Remarque : si vous appliquez le comportement Agiter à un paramètre Opacité réglé 
sur 100 %, l’effet obtenu est quasiment nul, car il ne reste que peu d’espace pour « s’agiter ». 
Pour un meilleur résultat, réglez le paramètre Opacité sur 0 ou choisissez Soustraire 
dans le menu local Mode Appliquer.
Comportements connexes
« Animation aléatoire, » « Rendre aléatoire »
Comportements Audio, Caméra, Suivi de l’animation, Particules, 
Réplicateur, Forme et Texte
Les comportements Audio, Caméra, Particules, Réplicateur, Forme et Texte sont conçus 
pour être appliqués en exclusivité aux objets correspondants, à savoir : les fichiers 
audio, les caméras, les émetteurs de particules ou leurs cellules, les réplicateurs 
ou leurs cellules source, les formes et le texte.
Â Pour en savoir plus sur les comportements Audio, voir le chapitre 13, « Utilisation de 
données audio », à la page 1203.
Â Pour en savoir plus sur les comportements Caméra, voir « compositing 3D » dans 
le manuel Motion Supplemental Documentation PDF.
Â Pour en savoir plus sur les comportements Particules, voir « Utilisation des comportements Particules » à la page 801. 
Â Pour en savoir plus sur les comportements Réplicateur, voir « Utilisation du comportement Réplicateur de séquence » à la page 888.Chapitre 5 Utilisation des comportements 495
Â Pour en savoir plus sur les comportements Forme, voir « Utilisation des comportements Forme » à la page 1147.
Â Pour en savoir plus sur les comportements Texte, voir « Utilisation des comportements 
Animation et Séquence de texte » à la page 702.
Pour en savoir plus sur les comportements Suivi de l’animation, y compris le comportement de paramètre Suivre, consultez « Suivi de l’animation » dans le manuel PDF Documentation supplémentaire de Motion.
Comportements Resynchronisation
Ces comportements sont appliqués à des séquences d’images, des séquences QuickTime 
et des couches clonées, dans le but de modifier leur contrôle du temps. Parmi les effets 
qu’ils permettent d’obtenir, vous pouvez notamment créer des images fixes, modifier 
la vitesse de lecture, inverser un plan, générer des imperfections ou des effets 
stroboscopiques, etc.
Important : vous ne pouvez appliquer les comportements Resynchronisation qu’à 
des séquences QuickTime, des séquences d’images et des couches clonées. En d’autres 
termes, vous ne pouvez pas les appliquer à un émetteur de particules, mais vous pouvez 
en revanche les appliquer à l’un de ses clones. Pour en savoir plus sur le clonage des 
couches, voir « Clonage de couches » à la page 315.
Image Flash
Ce comportement vous permet d’insérer de manière aléatoire une plage d’images définie par vos soins (adjacente à l’image actuelle) au cours de la lecture d’un plan.
Commandes disponibles dans la palette
La palette met à votre disposition les paramètres Images aléatoires, Plage d’images, 
Durée et Valeur aléatoire.
Comparaison entre les comportements Resynchronisation 
et les commandes Contrôle du temps de l’Inspecteur
Si vous sélectionnez un plan, un groupe de paramètres Contrôle du temps apparaît 
dans l’onglet Propriétés de l’Inspecteur. Ces commandes vous permettent d’obtenir 
les mêmes effets que les comportements Resynchronisation, tels que ralentir, accélérer, 
lire en boucle ou inverser un plan, mais elles affectent l’intégralité du plan. Tout l’intérêt 
des comportements Resynchronisation est que vous pouvez définir quelle partie 
du plan ils doivent affecter.
Toute modification apportée au contrôle du temps d’un plan à l’aide des commandes 
Contrôle du temps de l’Inspecteur est respectée par les comportements Resynchronisation. Par exemple, si vous modifiez la vitesse d’un plan à 50 % grâce aux paramètres 
Contrôle du temps, le comportement Resynchronisation appliqué utilise ce plan à 
vitesse réduite de moitié comme source. Pour en savoir plus sur les commandes Contrôle du temps de l’Inspecteur, voir « Resynchronisation » à la page 345.496 Chapitre 5 Utilisation des comportements
Paramètres dans l’Inspecteur
Images aléatoires : curseur vous permettant de définir la probabilité qu’une image soit 
remplacée par une image aléatoire sur toute la durée du comportement. Si vous réglez 
ce paramètre sur 0, aucune image aléatoire n’est insérée. À l’inverse, si vous le réglez 
sur 100, toutes les images sont aléatoires. La valeur par défaut est égale à 10 %.
Plage d’images : curseur vous permettant de définir la plage à partir de laquelle 
les images aléatoires sont choisies (autour de l’image actuelle). La valeur par défaut 
est égale à 10 images.
Durée : curseur vous permettant de définir la durée de la séquence d’images aléatoires. 
Par défaut, cette durée est égale à 1, ce qui signifie qu’1 seule image aléatoire est insérée 
à chaque fois. Si vous réglez le paramètre Durée sur 30, des séquences de 30 images 
(choisies en fonction du paramètre Plage d’images) sont insérées de manière aléatoire. 
La valeur Durée à la priorité sur le décompte Plage d’images (de telle sorte que toute 
nouvelle image aléatoire n’interrompe pas la séquence en cours).
Valeur aléatoire : bouton permettant de choisir un nouveau nombre de valeurs aléatoires. 
Ce nombre sert à générer de façon aléatoire de nouvelles valeurs en fonction des autres 
paramètres de ce comportement.
Conserver l’image
Ce comportement vous permet de conserver l’image située au niveau du point d’entrée 
du comportement sur toute la durée du comportement. La lecture du plan continue 
normalement après le point de sortie du comportement. Par exemple, si vous appliquez 
le comportement Conserver l’image au niveau de l’image 60 et qu’il se termine à 
l’image 300, le plan est lu normalement jusqu’à l’image 59, l’image 60 est conservée 
pendant 240 images, puis la lecture reprend normalement, de l’image 61 à l’image 301 
du plan.
Le comportement Conserver l’image est toujours appliqué au niveau de l’image actuelle 
(et non au début de l’objet).
Commandes disponibles dans la palette
La palette propose uniquement la commande Décalage.
Paramètres dans l’Inspecteur
Décalage : curseur permettant de définir le décalage de l’image conservée. Si vous 
le réglez sur 0 (la valeur par défaut), l’image située au début du comportement correspond à l’image conservée. En revanche, si vous le réglez sur 60, l’image correspondant 
au début du comportement (l’image conservée) est la 60e image après l’image de 
départ. La valeur de ce paramètre est exprimée en images.Chapitre 5 Utilisation des comportements 497
∏ Astuce : un certain tremblotement risque de survenir si vous appliquez le comportement Conserver l’image à une séquence entrelacée. Pour l’éviter, assurez-vous que le paramètre Ordre de trame est correctement défini dans l’Inspecteur. Pour modifier ce 
paramètre, sélectionnez la séquence dans l’onglet Média de la sous-fenêtre Projet, affichez l’onglet Média de l’Inspecteur, puis cliquez sur le menu local Ordre de trame pour 
faire votre choix.
En boucle
Ce comportement vous permet de lire en boucle une partie d’un plan sur toute sa durée. 
L’image de début de la boucle est déterminée par l’image de début du comportement. 
Par exemple, si vous appliquez ce comportement au début d’un plan et que vous réglez 
le paramètre Durée de la boucle sur 30, les 30 premières images du plan sont lues en 
boucle jusqu’à la fin du comportement. À la fin du comportement, la lecture reprend 
normalement à partir de l’image située à la fin de la durée de la boucle.
Commandes disponibles dans la palette
La palette propose le paramètre Durée de la boucle.
Paramètres dans l’Inspecteur
Durée de la boucle : curseur vous permettant de définir la durée des images lues 
en boucle. La valeur par défaut est égale à 30 images.
Ping-Pong
Ce comportement vous permet de lire par allers-retours une partie d’un plan sur toute 
la durée définie pour ce comportement. L’image de début de cet effet de ping-pong 
est déterminée par l’image de début du comportement. Par exemple, si vous appliquez 
ce comportement au début d’un plan et que vous réglez le paramètre Durée sur 30, 
les 30 premières images du plan sont lues normalement, puis en sens inverse, puis à 
nouveau normalement, etc., jusqu’à la fin du comportement. À la fin du comportement, 
la lecture reprend normalement.
Commandes disponibles dans la palette
La palette propose le paramètre Durée de la boucle.
Paramètres dans l’Inspecteur
Durée : curseur vous permettant de définir la durée (en images) de l’effet ping-pong. 
La valeur par défaut est égale à 30 images.
Relire
Ce comportement vous permet de repositionner la tête de lecture au début du comportement au niveau d’une image particulière, puis de lire le plan normalement à partir 
de cette image. La lecture du plan continue normalement après la fin du comportement. 
Vous pouvez ainsi déclencher la lecture d’un plan à des instants différents, sans pour 
autant avoir besoin de plusieurs versions de l’objet de la séquence.498 Chapitre 5 Utilisation des comportements
Commandes disponibles dans la palette
La palette propose uniquement les paramètres « Commencer à » et Heure de début.
Paramètres dans l’Inspecteur
Commencer à : menu local vous permettant de déterminer si la relecture démarre 
à partir d’un numéro d’image absolue ou d’une image décalée (par rapport au début 
de comportement). 
Image absolue : détermine si la relecture démarre au niveau de l’image indiquée 
dans le paramètre Heure de début. Par exemple, si le comportement commence à 
l’image 60 d’un plan et que vous réglez le paramètre Image de début sur 30, le plan 
est relu à partir de l’image 30 dès que la lecture atteint l’image 60.
Image décalée : vous permet de décaler l’image de début de la relecture. Par exemple, 
si le comportement commence à l’image 60 d’un plan et que vous réglez le paramètre 
Image de début sur 30, le plan est relu à partir de l’image 90 dès que la lecture atteint 
l’image 60. Si le paramètre Image de début est réglé sur –30, le plan est relu à partir 
de l’image 30.
Heure de début : curseur vous permettant de définir l’image de début à partir de 
laquelle le plan est relu. Par défaut, il s’agit de l’image 1.
Inverser
Ce comportement vous permet de lire un plan ou une séquence d’images à l’envers.
Commandes disponibles dans la palette
Il n’existe aucun paramètre pour ce comportement.
Paramètres dans l’Inspecteur
Il n’existe aucun paramètre pour ce comportement.
Inverser la boucle
Ce comportement vous permet de lire en boucle et à l’envers une partie d’un plan 
sur toute sa durée. Si vous réglez le paramètre Durée de la boucle sur 30 et que 
ce comportement commence sur l’image 1, les images 1 à 30 sont lues à l’envers, 
les images 31 à 60 en sens contraire, les images 61 à 90 à nouveau à l’envers, etc.
∏ Astuce : pour obtenir un effet cadencé agréable, réglez le paramètre Durée de 
la boucle sur 2.
Commandes disponibles dans la palette
La palette propose le paramètre Durée de la boucle.
Paramètres dans l’Inspecteur
Durée de la boucle : curseur vous permettant de définir la durée des images lues 
en boucle inversée. La valeur par défaut est égale à 30 images.Chapitre 5 Utilisation des comportements 499
Défiler
Tout comme le filtre du même nom, le comportement Défiler déplace une tête de lecture 
virtuelle le long d’un plan et vous permet ainsi de modifier le contrôle du temps de 
ce plan sans le déplacer dans la Timeline. De plus, il vous permet d’animer le paramètre 
Décalage en utilisant des images clés ou des comportements Paramètre, souvent avec 
des résultats intéressants. Tentez d’appliquer le comportement Osciller au décalage 
de l’image, avec le paramètre « Décalage de » réglé sur Image actuelle.
Remarque : vous pouvez également appliquer des comportements Paramètre 
au paramètre Valeur de resynchronisation disponible dans les commandes Contrôle 
du temps de l’image proprement dite. Les commandes Contrôle du temps sont situées 
dans l’onglet Propriétés. Réglez Time Remap sur Vitesse variable pour pouvoir accéder 
au paramètre Valeur de resynchronisation.
Commandes disponibles dans la palette
La palette propose les paramètres Décalage d’image à et Décalage de.
Paramètres dans l’Inspecteur
Décalage d’image : détermine le décalage de la tête de lecture virtuelle.
Décalage de : détermine la position à partir de laquelle la tête de lecture virtuelle 
est décalée. Vous avez le choix entre Première image et Image actuelle.
Important : le filtre Défiler n’a aucune incidence sur l’audio des plans.
Vitesse définie
Ce comportement vous permet de modifier la vitesse de lecture d’un plan. La vitesse 
définie par ce comportement est appliquée dès le point d’entrée du comportement 
et sur toute sa durée. La lecture du plan continue à sa vitesse normale après le point 
de sortie du comportement. Par exemple, si vous appliquez le comportement Vitesse 
définie au niveau de l’image 60 et qu’il se termine à l’image 300, le plan est lu normalement 
jusqu’à l’image 59, à la vitesse indiquée dans le comportement des images 60 à 300, 
puis à nouveau à vitesse normale à partir de l’image 301. Vous pouvez appliquer 
un effet d’atténuation en entrée ou en sortie à ce changement de vitesse.
Commandes disponibles dans la palette
La palette met à votre disposition les paramètres Vitesse, Atténuation dans le temps, 
Atténuation en courbe, Atténuation en fin de temps et Atténuation en sortie de courbe.
Paramètres dans l’Inspecteur
Vitesse : curseur déterminant la vitesse du plan sous forme de pourcentage. La valeur 
par défaut est de 100 % (la vitesse normale du plan). Un réglage à 50 % entraîne la lecture 
du plan à une vitesse réduite de moitié.
Remarque : vous avez la possibilité d’animer avec des images clés le paramètre Vitesse 
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Atténuation dans le temps : curseur vous permettant de définir le nombre d’images 
sur lesquelles l’atténuation en entrée du changement de vitesse survient (depuis le début 
du comportement). La valeur par défaut est égale à 20 images.
Atténuation en courbe : curseur vous permettant de définir la courbure de la pente lors 
de l’atténuation en entrée du changement de vitesse. Une valeur égale à 0 provoque 
une transition extrêmement accentuée vers la nouvelle vitesse. À 100, vous obtenez 
la transition la plus lisse possible. La valeur par défaut est égale à 50 %.
Atténuation en fin de temps : curseur vous permettant de définir le nombre d’images 
sur lesquelles l’atténuation en sortie du changement de vitesse survient (depuis la fin 
du comportement). La valeur par défaut est égale à 20 images.
Atténuation en sortie de courbe : curseur vous permettant de définir la courbure de 
la pente lors de l’atténuation en sortie du changement de vitesse. Une valeur égale à 0 
provoque une transition extrêmement accentuée depuis la nouvelle vitesse vers la vitesse 
d’origine. À 100, vous obtenez la transition la plus lisse possible. La valeur par défaut 
est égale à 50 %.
Stroboscope
Ce comportement simule une lumière stroboscopique ou une vidéo à faible fréquence 
d’images, en conservant un certain nombre d’images (défini par le paramètre Durée du 
stroboscope) pendant toute la lecture du plan. Si vous réglez, par exemple, le paramètre 
Durée du stroboscope sur 10, l’image 1 est conservée sur 10 images, puis l’image 11 
sur 10 images et l’images 21 sur 10 images, etc. Les images situées dans les intervalles 
(2 à 10, 12 à 20, 22 à 30, etc.) n’apparaissent pas.
Commandes disponibles dans la palette
La palette propose le paramètre Durée du stroboscope.
Paramètres dans l’Inspecteur
Durée du stroboscope : curseur permettant de définir le nombre d’images à conserver. 
Avec une valeur égale à 1, le plan est lu à vitesse normale. La valeur par défaut est 
égale à 5 images.
Imperfection
Ce comportement vous permet d’insérer de manière aléatoire des images conservées 
de durées aléatoires au cours de la lecture d’un plan. L’effet est similaire à la bande 
d’une cassette qui se colle au cours de sa lecture dans un magnétoscope.
Commandes disponibles dans la palette
La palette met à votre disposition les paramètres Niveau d’imperfection, Plage de durée 
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Paramètres dans l’Inspecteur
Niveau d’imperfection : curseur vous permettant de définir la probabilité qu’une image 
conservée soit générée au niveau d’une image donnée. Si vous réglez ce paramètre 
sur 0 %, aucune image conservée n’est créée. À 100 %, chaque image est conservée. 
Les valeurs comprises entre 0 et 100 indiquent la probabilité que des images (sur la durée 
du comportement) soit remplacées par des images conservées. La valeur par défaut est 
égale à 10 %.
Plage de durée : curseur permettant de définir la durée maximale des images conservées. 
Une valeur égale à 1 insère une seule image conservée à une fréquence fixée par 
le paramètre Niveau d’imperfection. Si vous augmentez la valeur du paramètre Plage 
de durée, vous augmentez la plage d’images conservées. Par exemple, une valeur égale 
à 30 crée aléatoirement des images conservées constituées d’au moins 1 image et d’au 
plus 30 images. La valeur par défaut est égale à 3 images.
Valeur aléatoire : bouton permettant de choisir un nouveau nombre de valeurs aléatoires. 
Ce nombre sert à générer de façon aléatoire de nouvelles valeurs en fonction des autres 
paramètres de ce comportement.
Comportements Simulation
Ces comportements réalisent deux types de tâches. Certains, tels que Gravité, animent 
les paramètres d’un objet de façon à simuler un phénomène réel. D’autres, tels qu’Attracteur et Repousser, ont une incidence sur les paramètres d’un ou plusieurs objets situés 
autour de l’objet auquel ils sont appliqués. Ces comportements vous permettent de créer 
des interactions très élaborées entre plusieurs objets d’un projet et ce, avec un minimum 
de réglages. Tout comme les comportements Animation standard, les comportements 
Simulation affectent des paramètres particuliers des objets. Il s’agit par exemple 
d’Attracteur, Gravité et Repousser.
Important : plusieurs paramètres des comportements Simulation affichent des cadres 
d’objet dans lesquels vous pouvez faire glisser les objets cible utilisés en tant qu’attracteurs, répulseurs, orbiteurs, etc. Il peut s’avérer difficile de faire glisser un objet dans 
l’un de ces cadres : veillez à cliquer sur le nom de l’objet dans l’onglet Couches et à 
faire glisser immédiatement l’objet vers le cadre (sans relâcher le bouton de la souris). 
Le comportement doit alors rester actif, même si vous cliquez sur un autre objet dans 
l’onglet Couches. Si vous cliquez sur un objet dans l’onglet Couches et que vous relâchez 
le bouton de la souris, l’objet est sélectionné, mais les paramètres du comportement 
ne sont plus affichés. Ce comportement est valable pour tous les cadres, cadres d’image 
et de source du masque compris.
Exemples d’utilisation de comportements Simulation
Pour prendre connaissance d’exemples d’utilisation des différents des comportements 
Simulation, voir « Exemples de comportements » à la page 528.502 Chapitre 5 Utilisation des comportements
Aligner sur l’animation
Ce comportement vous permet de modifier la rotation d’un objet de telle sorte qu’elle 
corresponde aux modifications apportées à sa direction le long d’une trajectoire d’animation. Il est conçu pour être combiné à d’autres comportements Simulation qui animent 
la position d’un objet ou à une trajectoire animée avec des images clés créée par vos soins.
Remarque : le comportement Aligner sur l’animation ne fonctionne pas sur les objets 
animés avec le comportement Trajectoire d’animation. Utilisez plutôt le comportement 
Magnétiser l’alignement sur l’animation (dans la sous-catégorie Animation standard).
Contrairement au comportement Magnétiser l’alignement sur l’animation, qui provoque 
des changements radicaux dans la rotation pour refléter les changements de direction, 
le comportement Aligner sur l’animation offre un effet plus naturel.
Dans l’exemple ci-dessus, le poisson se déplace le long d’une trajectoire d’animation 
définie par des images clés, mais il n’est pas aligné sur cette trajectoire (remarquez 
la poignée de rotation). Utilisez le comportement Aligner sur l’animation pour décaler 
son angle de rotation et lui permettre ainsi de regarder dans la direction de la trajectoire. 
En ajustant le paramètre Glissement, vous pouvez l’écarter très largement de son point 
d’ancrage, sachant qu’il suit les courbes de la trajectoire d’animation.
Commandes disponibles dans la palette
La palette met à votre disposition les paramètres Axe de rotation, Axe, Inverser l’axe, 
Tension du ressort et Glissement. Lorsque vous appliquez ce comportement à un groupe 
ou une couche contenant plusieurs objets (comme des particules, un texte ou un réplicateur), la case « Affecter les sous-objets » apparaît également dans la palette.
Avant utilisation du comportement Aligner 
sur l’animation
Après utilisation du comportement Aligner 
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Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Axe de rotation : menu local qui vous permet de faire pivoter l’objet autour de l’axe X, 
Y ou Z. Vous pouvez également choisir Tout pour faire pivoter l’objet autour des trois axes. 
L’axe de rotation par défaut correspond à l’axe Z.
Axe : menu local qui vous permet de préciser si l’objet doit s’aligner selon son axe 
horizontal ou vertical.
Inverser l’axe : case à cocher permettant d’inverser l’orientation selon laquelle l’objet 
s’aligne sur l’animation.
Tension du ressort : curseur déterminant avec quelle rapidité la rotation de l’objet change 
pour répondre à un changement de direction. Des valeurs peu élevées provoquent un 
décalage entre le changement de position d’un objet et le changement de rotation qui 
en résulte. Des valeurs élevées produisent des changements de rotation plus réactifs.
Glissement : curseur déterminant si le changement de rotation causé par ce comportement dépasse ou non la nouvelle direction de l’objet. Des valeurs de glissement peu 
élevées entraînent des changements élastiques de la rotation, avec une rotation d’avant 
en arrière, l’objet dépassant les changements de direction. Des valeurs plus élevées 
atténuent cet effet et la rotation de l’objet colle davantage aux changements subis. 
Avec des valeurs élevées, la rotation s’effectue également en retard sur le changement 
de position de l’objet.
Comportements connexes
« Magnétiser l’alignement sur l’animation »
Attiré vers
Ce comportement fait partie d’un groupe de comportements Simulation conçus 
pour vous permettre de créer des relations animées élaborées entre plusieurs objets. 
Ces comportements offrent de grandes possibilités et permettent la création d’effets 
complexes en un minimum d’étapes.504 Chapitre 5 Utilisation des comportements
Si vous appliquez le comportement Attiré vers à un objet, il se déplace en direction 
de l’unique cible indiquée, appelée « objet d’attraction ». Grâce à d’autres paramètres, 
vous pouvez définir la zone d’influence marquant à quelle distance un objet doit être 
placé de l’objet d’attraction pour être attiré et l’intensité de l’attraction.
Le paramètre Glissement permet de déterminer si les objets attirés dépassent et rebondissent sur l’objet d’attraction, ou si ils finissent par ralentir et s’arrêter à la position de 
l’objet cible.
Vous pouvez appliquer plusieurs comportements Attiré vers à un seul objet, chacun 
utilisant un objet d’attraction différent, afin de créer des situations où un objet rebondit 
au milieu de tous ceux qui l’attirent.
Commandes disponibles dans la palette
La palette affiche un cadre d’objet qui vous permet de définir un objet d’attraction, 
ainsi que les commandes Force, Type d’atténuation, Vitesse d’atténuation, Influence, 
Glissement et des boutons de sélection des axes de déplacement. Lorsque ce comportement est appliqué à un objet contenant plusieurs objets (par exemple, un groupe, 
des particules, un texte ou un réplicateur), la case « Affecter les sous-objets » apparaît 
également dans la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets 
constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, 
tous les objets contenus dans l’objet parent sont affectés simultanément par le comportement, comme s’ils ne faisaient qu’un.
Objet : cadre permettant de définir l’objet d’attraction. Pour ce faire, faites glisser l’objet 
cible de l’onglet Couches vers le cadre d’objet présent dans la palette Attiré vers 
ou l’Inspecteur. Vous pouvez également faire glisser l’objet cible sur le comportement 
Attiré vers dans l’onglet Couches.
Objet forme d’attraction
Comportement Attiré
vers appliqué à
un objet forme
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Force : curseur déterminant la vitesse à laquelle l’objet se déplace en direction de l’objet 
d’attraction. Dans le cas d’une valeur égale à 0, l’objet reste immobile. Plus la valeur 
indiquée est élevée, plus l’objet se déplace vite.
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle.
Â Linéaire : l’attraction s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est attiré et plus 
il se déplace vite en direction de l’objet d’attraction.
Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force d’attraction 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur déplacement en direction de l’objet 
d’attraction. Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus 
progressive. Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue 
beaucoup plus rapidement que dans le cas d’une atténuation linéaire.
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets 
se trouvant dans la zone d’influence se déplacent en direction de l’objet d’attraction. 
Les objets situés en dehors de cette zone restent à leur place.
Glissement : curseur pouvant servir à réduire la distance dont les objets attirés dépassent l’objet d’attraction. Avec des valeurs de glissement faibles, l’objet attiré va au-delà 
de l’objet d’attraction, puis rebondit sans cesse autour. Avec des valeurs élevées, l’objet 
s’immobilise plus rapidement.
Inclure X, Y et Z : boutons vous permettant d’indiquer selon quels axes le ou les objets 
attirés se déplacent en direction de l’objet d’attraction. Si vous activez l’axe Z, l’objet se 
déplace en direction de son objet d’attraction dans un espace tridimensionnel.
Comportements connexes
« Attracteur, », « Dérive attiré vers, », « Attracteur de dérive, », « En orbite, », « Ressort, », 
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Attracteur
Si vous appliquez un comportement Attracteur à un objet, les autres objets situés 
dans sa zone d’influence se déplacent dans sa direction. Vous pouvez alors déterminer 
la force d’attraction et la distance requise pour que l’attraction commence. 
Par défaut, les objets dépassent l’objet d’attraction, puis rebondissent autour sans jamais 
s’arrêter. Le paramètre Glissement permet de changer ce comportement en indiquant 
si les objets attirés doivent dépasser et rebondir sur l’objet d’attraction, ou s’ils doivent 
plutôt ralentir et s’arrêter à la position de l’objet cible. 
Vous pouvez utiliser le comportement Attracteur pour affecter tous les objets du Canevas 
se trouvant dans la zone d’attraction ou limiter son effet à une liste précise d’objets 
grâce au paramètre Affecter.
Ce comportement est aussi applicable à des objets en mouvement. Si vous animez 
la position de l’objet cible auquel vous avez appliqué le comportement Attracteur, 
tous les autres objets dans le Canevas sont attirés vers sa nouvelle position.
Commandes disponibles dans la palette
La palette affiche les commandes Affecter, Force, Type d’atténuation, Vitesse d’atténuation, 
Influence, Glissement et des boutons de sélection des axes de déplacement.
Paramètres dans l’Inspecteur
Affecter : menu local vous permettant de limiter les objets de votre projet affectés 
par le comportement Attracteur. Il existe trois options :
Â Tous les objets : tous les objets du Canevas sont affectés par le comportement 
Attracteur.
Â Objets connexes : réglage par défaut. Seuls les objets situés dans le même groupe 
que l’objet d’attraction sont affectés.
Â Objets spécifiques : seuls les objets figurant dans la liste Objets modifiés sont 
affectés par le comportement Attracteur.
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Â Objets modifiés : liste apparaissant lorsque l’option Objets spécifiques est sélectionnée dans le menu local Affecter. Faites glisser des objets dans cette liste depuis 
l’onglet Couches pour qu’ils soient affectés par le comportement Attracteur lorsque 
l’option Objets spécifiques est sélectionnée dans le menu local Affecter. Pour supprimer un élément de la liste, il vous suffit de le sélectionner, puis de cliquer sur 
Supprimer.
Force : curseur déterminant la vitesse à laquelle les objets attirés se déplacent en direction de l’objet cible. Dans le cas d’une valeur égale à 0, les objets attirés restent immobiles. Plus la valeur indiquée est élevée, plus les objets attirés se déplacent vite.
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle. 
Â Linéaire : l’attraction s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est attiré et plus 
il se déplace vite en direction de l’objet d’attraction.
Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force d’attraction 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur déplacement en direction de l’objet 
d’attraction. Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus 
progressive. Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue 
beaucoup plus rapidement que dans le cas d’une atténuation linéaire.
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets 
se trouvant dans la zone d’influence se déplacent en direction de l’objet d’attraction. 
Les objets situés en dehors de cette zone restent à leur place.
Glissement : curseur pouvant servir à réduire la distance dont les objets attirés dépassent l’objet d’attraction. Avec des valeurs de glissement faibles, l’objet attiré va au-delà 
de l’objet d’attraction, puis rebondit sans cesse autour. Avec des valeurs élevées, l’objet 
s’immobilise plus rapidement.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan le ou les objets attirés se déplacent en direction de l’objet d’attraction. Par exemple, si vous activez les axes X 
et Y, l’objet se déplace dans le plan (X,Y). De même, si vous activez les axes Y et Z, l’objet se 
déplace dans le plan (Y,Z).
Comportements connexes
« Attiré vers, », « Dérive attiré vers, », « Attracteur de dérive, », « En orbite, », « Ressort, », 
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Glissement
Ce comportement vous permet de simuler la force de frottement exercée sur un objet 
en mouvement, en le ralentissant au fil du temps. Grâce à ce comportement, vous pouvez 
facilement ralentir des objets comportant plusieurs comportements qui forment 
une animation complexe.
Commandes disponibles dans la palette
La palette vous permet d’ajuster le paramètre Quantité et affiche des boutons de 
sélection des axes de déplacement. Lorsque ce comportement est appliqué à un objet 
contenant plusieurs objets (par exemple, un groupe, des particules, un texte ou un 
réplicateur), la case « Affecter les sous-objets » apparaît également dans la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Quantité : curseurs servant à ralentir un objet au fil du temps, jusqu’à son arrêt éventuel. 
Avec des valeurs élevées, l’objet s’immobilise plus rapidement. Cliquez sur le triangle 
d’affichage en regard du paramètre Quantité afin d’appliquer le glissement séparément 
aux valeurs X, Y et Z. Vous pouvez ainsi créer une situation où la vitesse verticale de l’objet 
ralentit, par exemple, plus rapidement que sa vitesse horizontale.
Inclure X, Y et Z : boutons vous permettant d’indiquer le plan dans lequel le glissement 
est appliqué. Par exemple, si vous activez les axes X et Y, l’objet glisse dans le plan (X,Y). 
De même, si vous activez les axes Y et Z, l’objet glisse dans le plan (Y,Z).
Comportements connexes
« Mouvement de rotation »
Dérive attiré vers
Ce comportement est comparable au comportement Attiré vers, sauf que l’objet 
se déplace par défaut vers l’objet d’attraction et s’immobilise, au lieu de le dépasser 
et de rebondir autour.
Commandes disponibles dans la palette
La palette affiche un cadre d’objet qui vous permet de définir un objet d’attraction, 
ainsi que curseurs pour les paramètres Force et Glissement et des boutons de sélection 
des axes de déplacement. Lorsque ce comportement est appliqué à un objet contenant 
plusieurs objets (par exemple, un groupe, des particules, un texte ou un réplicateur), 
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Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Objet : cadre permettant de définir l’objet d’attraction. Pour ce faire, faites glisser l’objet 
cible de l’onglet Couches vers le cadre d’objet présent dans la palette Dérive attiré vers 
ou l’Inspecteur. Vous pouvez également faire glisser l’objet cible sur le comportement 
Dérive attiré vers dans l’onglet Couches.
Force : curseur déterminant la vitesse à laquelle l’objet se déplace en direction de l’objet 
d’attraction. Dans le cas d’une valeur égale à 0, l’objet reste immobile. Plus la valeur 
indiquée est élevée, plus l’objet se déplace vite.
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle.
Â Linéaire : l’attraction s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est attiré et plus 
il se déplace vite en direction de l’objet d’attraction.
Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force d’attraction 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur déplacement en direction de l’objet 
d’attraction. Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus 
progressive. Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue 
beaucoup plus rapidement que dans le cas d’une atténuation linéaire.
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets 
se trouvant dans la zone d’influence se déplacent en direction de l’objet d’attraction. 
Les objets situés en dehors de cette zone restent à leur place.
Glissement : curseur pouvant servir à réduire la distance dont les objets attirés dépassent l’objet d’attraction. Avec des valeurs de glissement faibles, l’objet attiré va au-delà 
de l’objet d’attraction, puis rebondit sans cesse autour. Avec des valeurs élevées, l’objet 
s’immobilise plus rapidement.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan le ou les objets 
attirés dérivent en direction de l’objet d’attraction. Par exemple, si vous activez les axes X 
et Y, l’objet dérive dans le plan (X,Y). De même, si vous activez les axes Y et Z, l’objet 
dérive dans le plan (Y,Z).510 Chapitre 5 Utilisation des comportements
Comportements connexes
« Attiré vers, », « Attracteur, », « Attracteur de dérive, », « En orbite, », « Ressort, », 
« Vortex ».
Attracteur de dérive
Ce comportement est comparable au comportement Attracteur, sauf que les objets 
situés dans la zone d’influence se déplacent par défaut vers l’objet d’attraction et 
s’immobilisent, au lieu de le dépasser et de rebondir autour.
Commandes disponibles dans la palette
La palette met à votre disposition les commandes Affecter, Force, Glissement et 
des boutons de sélection des axes de déplacement.
Paramètres dans l’Inspecteur
Affecter : menu local vous permettant de limiter les objets de votre projet affectés par 
le comportement Attracteur de dérive. Il existe trois options :
Â Tous les objets : tous les objets du Canevas sont affectés par le comportement 
Attracteur de dérive.
Â Objets connexes : réglage par défaut. Seuls les objets situés dans le même groupe 
que l’objet d’attraction sont affectés.
Â Objets spécifiques : seuls les objets figurant dans la liste Objets modifiés sont affectés 
par le comportement Attracteur de dérive.
Â Objets modifiés : liste apparaissant lorsque l’option Objets spécifiques est sélectionnée dans le menu local Affecter. Faites glisser des objets ou des groupes de 
l’onglet Couches vers cette liste pour qu’ils soient affectés par le comportement 
Attracteur de dérive. Pour supprimer un élément de la liste, il vous suffit de 
le sélectionner, puis de cliquer sur Supprimer.
Force : curseur déterminant la vitesse à laquelle les objets attirés se déplacent en direction 
de l’objet cible. Dans le cas d’une valeur égale à 0, les objets attirés restent immobiles. 
Plus la valeur indiquée est élevée, plus les objets attirés se déplacent vite.
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle.
Â Linéaire : l’attraction s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est attiré et plus 
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Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force d’attraction 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur déplacement en direction de l’objet 
d’attraction. Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus 
progressive. Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue 
beaucoup plus rapidement que dans le cas d’une atténuation linéaire.
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets 
se trouvant dans la zone d’influence se déplacent en direction de l’objet d’attraction. 
Les objets situés en dehors de cette zone restent à leur place.
Glissement : curseur pouvant servir à réduire la distance dont les objets attirés dépassent l’objet d’attraction. Avec des valeurs de glissement faibles, l’objet attiré va au-delà 
de l’objet d’attraction, puis rebondit sans cesse autour. Avec des valeurs élevées, l’objet 
s’immobilise plus rapidement.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan le ou les objets 
attirés dérivent en direction de l’objet d’attraction. Par exemple, si vous activez les axes X 
et Y, l’objet dérive dans le plan (X,Y). De même, si vous activez les axes Y et Z, l’objet dérive 
dans le plan (Y,Z).
Comportements connexes
« Attiré vers, », « Attracteur, », « Dérive attiré vers, », « En orbite, », « Ressort, », « Vortex ».
Collision sur les bords
Ce comportement s’avère fort utile pour configurer des simulations d’animation élaborées 
sans déplacer les objets effectivement présents dans le Canevas. Les objets auxquels 
vous appliquez ce comportement s’immobilisent ou rebondissent après être entrés 
en collision avec le bord du Canevas. Par exemple, si vous appliquez le comportement 
Lancer à un objet et optez pour une vitesse telle que cet objet est envoyé vers le bord 
du Canevas, puis lui appliquez le comportement Collision sur les bords, l’objet bute 
contre le bord et rebondit en fonction du paramètre Force de rebond.
Trajectoire d’animation d’un objet lancé, 
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L’angle selon lequel l’objet rebondit dépend de son angle de collision avec le bord du 
cadre, alors que sa vitesse de déplacement après rebond varie en fonction du paramè-
tre Force de rebond.
Remarque : le comportement Collision sur les bords n’a aucun effet sur les objets qui 
sont plus grands que le Canevas.
Important : par défaut, le comportement Collision sur les bords utilise la taille du projet 
et le cadre de sélection pour déterminer de quelle façon l’objet rebondit sur le bord 
du Canevas. Dans le cas d’un projet NTSC Broadcast SD (720 x 486 pixels), un objet 
rebondit sur les bords droit et gauche du projet, au niveau de son cadre de sélection. 
Avec les groupes (particules, texte et objets), seul le centre de l’objet est utilisé. Vous pouvez 
également faire en sorte que l’objet se déplace au-delà des limites du Canevas avant 
de rebondir grâce aux paramètres Largeur et Hauteur. Si vous appliquez ce comportement à un objet doté d’un canal alpha plus petit que son cadre de sélection, réglez 
le paramètre Rognage dans l’onglet Propriétés de cet objet, afin d’adapter le plus 
possible le cadre de sélection au bord de l’image.
Commandes disponibles dans la palette
La palette met à votre disposition les commandes Force de rebond, Largeur, Hauteur 
et Profondeur. Lorsque ce comportement est appliqué à un objet contenant plusieurs 
objets (par exemple, un groupe, des particules, un texte ou un réplicateur), la case 
« Affecter les sous-objets » apparaît également dans la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Force de rebond : vitesse à laquelle les objets se déplacent après être entrés en collision 
avec un bord. En cas de valeur égale à 0, l’objet s’immobilise complètement après sa 
collision avec un bord perpendiculaire à la direction de son déplacement. Des valeurs 
élevées accélèrent son déplacement après le rebond. Ce paramètre ne ralentit l’objet 
que si sa direction est perpendiculaire au bord contre lequel il rebondit.
Bords actifs : six cases à cocher déterminent les bords détectés par le comportement 
Collision sur les bords. Vous pouvez activer et désactiver des bords à votre guise.
Face gauche : la collision a lieu contre le bord gauche.
Face droite : la collision a lieu contre le bord droit.
Face haut : la collision a lieu contre le bord supérieur.
Face bas : la collision a lieu contre le bord inférieur.Chapitre 5 Utilisation des comportements 513
Face arrière : la collision a lieu contre le bord arrière (selon l’axe Z).
Face avant : la collision a lieu contre le bord avant (selon l’axe Z).
Largeur : curseur vous permettant de définir une largeur (entre les bords droit et gauche 
du Canevas) différente de la taille du projet. Par défaut, le paramètre Largeur correspond 
à la taille du projet.
Hauteur : curseur vous permettant de définir une hauteur (entre les bords supérieur 
et inférieur du Canevas) différente de la taille du projet. Par défaut, le paramètre Hauteur 
correspond à la taille du projet.
Profondeur : curseur vous permettant de définir une profondeur (entre les faces 
arrière et avant, selon l’axe Z) pour la collision sur les bords. Par défaut, le paramètre 
Profondeur est réglé sur 100 pixels.
Gravité
Ce comportement vous permet de faire tomber au fil du temps un objet ou tous les objets 
d’un groupe (si la case Affecter les sous-objets est cochée). Il est possible de réduire 
et d’augmenter l’accélération gravitationnelle, ce qui modifie la vitesse de la chute. 
Si vous appliquez le comportement Gravité à des objets, ils continuent à tomber au-delà 
du bord inférieur du Canevas (sauf si vous leur avez également appliqué le comportement 
Collision sur les bords).
Le comportement Gravité peut s’utiliser conjointement avec d’autres comportements 
qui animent la position des objets : vous obtenez ainsi des arcs et des trajectoires réalistes 
simulant des objets tombant à terre après avoir été lancés. Par exemple, appliquez 
le comportement Lancer à un objet pour l’envoyer en l’air, puis le comportement 
Gravité pour qu’il décrive un arc et tombe au-delà du bord inférieur du Canevas.
Vous pouvez également attribuer une valeur négative au paramètre Accélération 
pour générer un phénomène « anti-gravitationnel » faisant s’élever l’objet.
Trajectoire d’animation d’un 
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Commandes disponibles dans la palette
La palette vous permet d’ajuster le paramètre Accélération. Lorsque vous appliquez ce 
comportement à un objet contenant plusieurs objets (comme un groupe, des particules, 
un texte ou un réplicateur), la case « Affecter les sous-objets » apparaît également dans 
la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Accélération : curseur déterminant la force de gravité subie par l’objet cible. Plus cette 
valeur est élevée, plus l’objet cible tombe rapidement.
Comportements connexes
« Trajectoire d’animation, », « Animation aléatoire, », « Lancer, », « Vent ».
En orbite
Ce comportement est comparable au comportement Attiré vers. Ses réglages par 
défaut dotent l’objet d’une vitesse initiale suffisante pour tourner en orbite autour 
d’un autre objet en décrivant un cercle parfait. 
Remarque : des comportements, tels que Attracteur et Repousser, appliqués à 
des objets situés à proximité peuvent perturber le mouvement d’un objet doté 
du comportement En orbite.
Trajectoire d’animation d’un objet 
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Commandes disponibles dans la palette
La palette affiche un cadre d’objet qui vous permet de définir un objet d’attraction, 
ainsi que les commandes Force, Type d’atténuation, Vitesse d’atténuation, Influence, 
Glissement, Direction et des boutons de sélection des axes de déplacement et de l’axe 
de perche. Lorsque ce comportement est appliqué à un objet contenant plusieurs 
objets (par exemple, un groupe, des particules, un texte ou un réplicateur), la case 
« Affecter les sous-objets » apparaît également dans la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Objet : cadre permettant de définir l’objet autour duquel tourner. Pour ce faire, faites 
glisser l’objet cible de l’onglet Couches vers le cadre d’objet présent dans la palette 
En orbite ou l’Inspecteur. Vous pouvez également faire glisser l’objet cible sur le comportement En orbite dans l’onglet Couches.
Force : curseur déterminant la vitesse à laquelle l’objet se déplace.
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle. L’option par défaut est Linéaire.
Â Linéaire : l’attraction s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est attiré et plus 
il se déplace vite en direction de l’objet d’attraction.
Cadre d’image servant à définir 
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Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force d’attraction 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur déplacement en direction de l’objet 
d’attraction. Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus 
progressive. Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue 
beaucoup plus rapidement que dans le cas d’une atténuation linéaire.
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets 
se trouvant dans la zone d’influence se déplacent en direction de l’objet d’attraction. 
Les objets situés en dehors de cette zone restent à leur place.
Glissement : la valeur par défaut du comportement En orbite est 0, ce qui correspond 
à une orbite stable. Toute autre valeur réduit l’orbite et l’objet affecté décrit alors une 
spirale autour de l’objet d’attraction.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan le ou les objets 
tournent en orbite. Si vous activez, par exemple, X et Y, l’objet tourne en orbite dans 
le plan (X,Y). Dans l’illustration ci-dessous, X et Y sont activés dans le paramètre Inclure. 
Les trajectoires d’animation tracées en jaune représentent le mouvement des étoiles 
blanches autour de l’objet cible (l’étoile avec un contour orange). Le cadre gris clair 
représente la limite du groupe.
Dans l’illustration ci-dessous, Y et Z sont activés dans le paramètre Inclure. Les étoiles 
blanches tournent alors autour de l’objet cible dans le plan (Y,Z).Chapitre 5 Utilisation des comportements 517
Axe de perche : ce paramètre n’est disponible que si vous activez les axes X, Y et Z 
dans le paramètre Inclure. Comme tous les points sont à une distance fixe de l’objet 
cible ou attracteur (l’axe de perche), vous pouvez visualiser l’objet sur une sphère 
représentant toutes les orbites possibles, l’objet cible étant situé au centre de cette 
sphère. Le paramètre Axe de perche définit les deux points sur la sphère par lesquels 
l’orbite doit passer.
Â X : l’image suivante illustre le paramètre Axe de perche réglé sur X. Le cadre gris clair 
représente la limite du groupe.
Â Y : l’image suivante illustre le paramètre Axe de perche réglé sur Y.
Â Z : l’image suivante illustre le paramètre Axe de perche réglé sur Z.518 Chapitre 5 Utilisation des comportements
Â Aléatoire : lorsque cette option est sélectionnée, les axes sont décalés vers 
une position aléatoire.
Direction : menu local permettant de décider le sens de rotation des objets 
(sens des aiguilles d’une montre ou inverse).
Comportements connexes
« Attiré vers, », « Attracteur, », « Dérive attiré vers, », « Attracteur de dérive, », « Ressort, », 
« Vortex ».
Animation aléatoire
Lorsque vous appliquez le comportement Animation aléatoire à un objet, il anime 
la position de cet objet et le déplace dans le Canevas selon une trajectoire aléatoire.
Même si l’animation créée via ce comportement semble aléatoire, elle est en fait prédé-
terminée par le groupe de paramètres choisis. Tant que vous ne modifiez pas les paramètres, la trajectoire d’animation générée par ce comportement reste inchangée. 
Si vous n’êtes pas satisfait de la trajectoire aléatoire obtenue, cliquez sur le bouton 
Générer dans la palette ou l’onglet Comportements de l’Inspecteur afin de choisir 
un nouveau nombre de valeurs aléatoires. Ce nombre sert à créer une autre trajectoire. 
Trajectoire d’animation d’une forme affectée 
par le comportement Animation aléatoire. 
La forme de la trajectoire est fonction 
du paramètre Valeur.Chapitre 5 Utilisation des comportements 519
Le comportement Animation aléatoire s’avère très utile pour créer rapidement diverses 
trajectoires pour de nombreux objets à déplacer simultanément. Vous pouvez, 
par exemple, disposer dix objets dans le Canevas et leur appliquer à tous 
le comportement Animation aléatoire.
Vous pouvez également utiliser le comportement Animation aléatoire pour faire varier 
des trajectoires d’animation créées par d’autres comportements affectant la position 
d’un objet. Par exemple, appliquez le comportement Animation aléatoire à un objet 
déjà affecté par le comportement En orbite pour obtenir une trajectoire orbitale plus 
irrégulière.
Commandes disponibles dans la palette
La palette met à votre disposition les commandes Quantité, Fréquence, Bruit, Glissement, 
Valeur aléatoire et des boutons de sélection des axes de déplacement. Lorsque ce comportement est appliqué à un objet contenant plusieurs objets (par exemple, un groupe, 
des particules, un texte ou un réplicateur), la case « Affecter les sous-objets » apparaît 
également dans la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Quantité : curseur déterminant la vitesse à laquelle l’objet se déplace en modifiant 
la longueur de sa trajectoire d’animation. Des valeurs élevées entraînent une animation 
plus rapide et des trajectoires d’animation plus longues.
Forme affectée par le comportement 
En orbite
Comportement En orbite modifié par 
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Fréquence : curseur déterminant le nombre de virages dans la trajectoire d’animation, 
illustrés par toutes les courbures visibles. Des valeurs élevées augmentent le nombre 
de virages dans la trajectoire d’animation. Des valeurs faibles rendent les trajectoires 
plus droites.
Bruit : curseur déterminant un autre niveau d’irrégularité pour la forme de la trajectoire 
d’animation définie par le paramètre Quantité. Des valeurs élevées donnent une trajectoire plus irrégulière.
Glissement : curseur contrôlant la vitesse à laquelle l’objet se déplace le long de 
sa trajectoire d’animation. Alors que le paramètre Quantité définit la longueur de 
la trajectoire, le paramètre Glissement rétrécit ou élargit cette dernière dans son 
ensemble.
Inclure X, Y et Z : boutons vous permettant d’indiquer le plan dans lequel le mouvement 
aléatoire est appliqué. Par exemple, si vous activez les axes X et Y, le mouvement 
s’effectue dans le plan (X,Y). De même, si vous activez les axes Y et Z, le mouvement 
s’effectue dans le plan (Y,Z).
Valeur aléatoire : bouton permettant de choisir un nouveau nombre de valeurs aléatoires. 
Ce nombre sert à générer de façon aléatoire de nouvelles trajectoires d’animation 
en fonction des valeurs choisies pour les autres paramètres de ce comportement.
Comportements connexes
« Trajectoire d’animation, », « Gravité, », « Lancer, », « Vent ».
Repousser
Si vous appliquez le comportement Repousser à un objet, il repousse tous les objets 
situés dans sa zone d’influence dans le Canevas. Vous avez alors la possibilité de réduire 
ou d’augmenter la force avec laquelle les objets sont repoussés, ainsi que la distance 
qu’ils parcourent lorsqu’ils sont repoussés.
Avant Après
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Vous pouvez également préciser les objets affectés par ce comportement, créant ainsi 
un effet grâce auquel seuls certains objets se déplacent, alors que d’autres restent 
immobiles.
Le comportement Repousser est l’opposé du comportement Attracteur. Il fait partie 
d’un groupe de comportements Simulation conçus pour vous permettre de créer 
des relations animées élaborées entre plusieurs objets.
Commandes disponibles dans la palette
La palette affiche les commandes Affecter, Force, Type d’atténuation, Vitesse d’atténuation, 
Influence, Glissement et des boutons de sélection des axes de déplacement.
Paramètres dans l’Inspecteur
Affecter : menu local vous permettant de limiter les objets de votre projet affectés 
par le comportement Repousser. Il existe trois options :
Â Tous les objets : tous les objets du Canevas sont affectés par le comportement 
Repousser.
Â Objets connexes : réglage par défaut. Seuls les objets situés dans le même groupe 
que l’objet de répulsion sont affectés.
Â Objets spécifiques : seuls les objets figurant dans la liste Objets modifiés sont affectés 
par le comportement Repousser.
Â Objets modifiés : liste apparaissant lorsque l’option Objets spécifiques est sélectionnée dans le menu local Affecter. Faites glisser des objets ou des groupes de 
l’onglet Couches vers cette liste pour qu’ils soient affectés par le comportement 
Repousser. Pour supprimer un élément de la liste, il vous suffit de le sélectionner, 
puis de cliquer sur Supprimer.
Force : curseur déterminant la vitesse à laquelle les objets repoussés s’éloignent 
de l’objet. Dans le cas d’une valeur égale à 0, les objets repoussés restent immobiles. 
Plus la valeur indiquée est élevée, plus les objets repoussés se déplacent vite.
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle.
Â Linéaire : la répulsion s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est repoussé 
et plus il s’éloigne vite de l’objet de répulsion.
Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force de répulsion 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur éloignement de l’objet de répulsion. 
Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus progressive. 
Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue beaucoup plus 
rapidement que dans le cas d’une atténuation linéaire.522 Chapitre 5 Utilisation des comportements
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets se 
trouvant dans la zone d’influence s’éloignent de l’objet de répulsion. Les objets situés 
en dehors de cette zone restent à leur place.
Glissement : curseur pouvant servir à réduire la distance dont les objets repoussés 
s’éloignent de l’objet de répulsion.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan les objets 
repoussés s’éloignent de l’objet doté du comportement Repousser. Par exemple, 
si vous activez les axes X et Y, l’objet s’éloigne dans le plan (X,Y). De même, si vous 
activez les axes Y et Z, l’objet s’éloigne dans le plan (Y,Z).
Comportements connexes
« Repousser à partir de »
Repousser à partir de
Alors que le comportement Repousser permet de repousser d’autres objets, le comportement Repousser à partir de provoque l’effet inverse. En effet, l’objet auquel il est appliqué 
s’éloigne d’un objet sélectionné dans le Canevas.
Commandes disponibles dans la palette
La palette affiche un cadre d’image qui vous permet de définir un objet de répulsion, 
ainsi que les commandes Force, Type d’atténuation, Vitesse d’atténuation, Influence, 
Glissement et des boutons de sélection des axes de déplacement. Lorsque ce comportement est appliqué à un objet contenant plusieurs objets (par exemple, un groupe, 
des particules, un texte ou un réplicateur), la case « Affecter les sous-objets » apparaît 
également dans la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets 
constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, 
tous les objets contenus dans l’objet parent sont affectés simultanément par le comportement, comme s’ils ne faisaient qu’un.
Objet : cadre permettant de définir l’objet de répulsion.
Force : curseur déterminant la vitesse à laquelle l’objet est repoussé. Dans le cas d’une 
valeur égale à 0, l’objet repoussé reste immobile. Plus la valeur indiquée est élevée, 
plus l’objet repoussé se déplace vite.Chapitre 5 Utilisation des comportements 523
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle.
Â Linéaire : la répulsion s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est repoussé 
et plus il s’éloigne vite de l’objet de répulsion.
Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force de répulsion 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur éloignement de l’objet de répulsion. 
Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus progressive. 
Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue beaucoup plus 
rapidement que dans le cas d’une atténuation linéaire.
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets 
se trouvant dans la zone d’influence s’éloignent de l’objet de répulsion. Les objets 
situés en dehors de cette zone restent à leur place.
Glissement : curseur pouvant servir à réduire la distance dont le ou les objets repoussés 
s’éloignent de l’objet de répulsion.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan les objets 
s’éloignent de l’objet sélectionné. Par exemple, si vous activez les axes X et Y, l’objet 
se déplace dans le plan (X,Y). De même, si vous activez les axes Y et Z, l’objet 
se déplace dans le plan (Y,Z).
Comportements connexes
« Repousser »
Mouvement de rotation
Ce comportement est semblable au comportement Glissement, sauf qu’il influence 
la Rotation au lieu de la position. Il vous permet de simuler la force de frottement exercée 
sur les objets qui pivotent du fait des modifications apportées à leur paramètre Rotation 
avec des images clés ou d’autres comportements. Avec des valeurs élevées, vous pouvez 
ralentir les changements de rotation jusqu’à un arrêt final.
Commandes disponibles dans la palette
La palette vous permet d’ajuster le paramètre Quantité. Lorsque ce comportement est 
appliqué à un objet contenant plusieurs objets (par exemple, un groupe, des particules, 
un texte ou un réplicateur), la case « Affecter les sous-objets » apparaît également dans 
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Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Quantité : curseur servant à ralentir la rotation d’un objet au fil du temps, jusqu’à son 
arrêt éventuel. Des valeurs élevées font s’arrêter plus vite la rotation. 
Comportements connexes
« Glissement »
Ressort
Ce comportement vous permet d’établir une relation entre deux objets, de telle sorte 
que l’objet auquel il est appliqué effectue des va-et-vient autour de l’autre. Vous devez 
utiliser le paramètre Attiré vers pour indiquer l’objet servant de cible et de centre 
au comportement Ressort. D’autres paramètres vous permettent de fixer la vitesse 
du comportement (Tension du ressort) et l’accélération de l’objet à chaque changement 
de direction (Longueur de détente).
Si l’objet indiqué dans le paramètre Attiré vers est à l’arrêt, l’animation est assez simple 
et l’objet en mouvement effectue des va-et-vient selon une ligne droite. En revanche, 
si l’objet indiqué dans le paramètre Attiré vers est animé, le mouvement de l’autre 
objet est beaucoup plus complexe, avec des changements de direction en fonction 
de la vitesse de l’objet défini dans le paramètre Attiré vers.
Commandes disponibles dans la palette
La palette affiche un cadre d’image qui vous permet de définir l’objet Attiré vers. 
Vous y avez également accès aux paramètres Tension du ressort, Longueur de détente 
et à des boutons de sélection des axes de déplacement. Une case permet d’activer 
le paramètre Repousser. Lorsque ce comportement est appliqué à un objet contenant 
plusieurs objets (par exemple, un groupe, des particules, un texte ou un réplicateur), 
la case « Affecter les sous-objets » apparaît également dans la palette.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement 
à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.Chapitre 5 Utilisation des comportements 525
Attiré vers : cadre d’image permettant de définir l’objet d’attraction. Pour ce faire, faites 
glisser l’objet cible de l’onglet Couches vers le cadre Attiré vers présent dans la palette 
Ressort ou l’Inspecteur. Vous pouvez également faire glisser l’objet cible sur le comportement Ressort dans l’onglet Couches.
Tension du ressort : curseur déterminant la vitesse à laquelle l’objet est tiré en direction 
de l’objet d’attraction.
Longueur de détente : distance depuis l’objet cible à partir de laquelle l’attraction 
diminue jusqu’à atteindre une valeur nulle. Sachant que la distance de l’objet 
en mouvement augmente au-delà de ce point, la force d’attraction augmente 
proportionnellement pour le faire revenir vers l’objet cible.
Repousser : cochez cette case pour que les objets s’écartent l’un de l’autre lorsque 
le premier se rapproche de l’objet d’attraction au-delà de la valeur Longueur 
de détente. Désactivez-la pour qu’aucune force de répulsion ne soit appliquée.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan l’objet affecté 
effectue des va-et-vient autour de l’objet d’attraction. Par exemple, si vous activez 
les axes X et Y, les va-et-vient s’effectuent dans le plan (X,Y). De même, si vous activez 
les axes Y et Z, les va-et-vient s’effectuent dans le plan (Y,Z).
Comportements connexes
« Attiré vers, », « Attracteur, », « Dérive attiré vers, », « Attracteur de dérive, », « En 
orbite, », « Vortex ».
Vortex
Ce comportement est l’opposé de En orbite. Alors que le comportement En orbite fait 
tourner un objet autour d’un objet cible, le comportement Vortex exerce une force sur 
tous les objets entourant l’objet auquel il est appliqué.
Commandes disponibles dans la palette
La palette affiche un menu local vous permettant de limiter les objets affectés par ce 
comportement, ainsi que les commandes Force, Type d’atténuation, Vitesse d’atténuation, 
Influence, Glissement, Direction et des boutons de sélection des axes de déplacement.
Paramètres dans l’Inspecteur
Affecter : menu local vous permettant de limiter les objets de votre projet affectés 
par le comportement Vortex. Il existe trois options :
Â Tous les objets : tous les objets du Canevas sont affectés par le comportement Vortex.
Â Objets connexes : réglage par défaut. Seuls les objets situés dans le même objet que 
l’objet d’attraction sont affectés.526 Chapitre 5 Utilisation des comportements
Â Objets spécifiques : seuls les objets figurant dans la liste Objets modifiés sont affectés 
par le comportement Vortex.
Â Objets modifiés : liste apparaissant lorsque l’option Objets spécifiques est 
sélectionnée dans le menu local Affecter. Faites glisser des objets dans cette liste 
depuis l’onglet Couches pour qu’ils soient affectés par le comportement Vortex 
lorsque l’option Objets spécifiques est sélectionnée dans le menu local Affecter. 
Pour supprimer un élément de la liste, il vous suffit de le sélectionner, puis de 
cliquer sur Supprimer.
Force : curseur déterminant la vitesse à laquelle les objets affectés se déplacent autour 
de l’objet d’attraction.
Type d’atténuation : menu local déterminant si la distance fixée par le paramètre 
Influence s’atténue de façon linéaire ou exponentielle. L’option par défaut est Linéaire.
Â Linéaire : l’attraction s’atténue proportionnellement à la distance de l’objet.
Â Exponentiel : plus un objet est proche de la zone d’influence, plus il est attiré et plus 
il se déplace vite en direction de l’objet d’attraction.
Vitesse d’atténuation : cette valeur détermine à quelle vitesse la force d’attraction 
entre des objets affectés par ce comportement s’atténue. Une valeur faible provoque 
une accélération rapide des objets lors de leur déplacement en direction de l’objet 
d’attraction. Avec une valeur plus élevée, les objets accélèrent de façon beaucoup plus 
progressive. Si vous réglez Type d’atténuation sur Exponentiel, l’attraction s’atténue 
beaucoup plus rapidement que dans le cas d’une atténuation linéaire.
Influence : curseur déterminant le rayon du cercle d’influence (en pixels). Les objets 
se trouvant dans la zone d’influence se déplacent en direction de l’objet d’attraction. 
Les objets situés en dehors de cette zone restent à leur place.
Glissement : la valeur par défaut du comportement Vortex est 0, ce qui correspond à 
un vortex stable. Toute autre valeur réduit le vortex et l’objet affecté décrit alors une 
spirale autour de l’objet d’attraction.
Inclure X, Y et Z : boutons vous permettant d’indiquer dans quel plan les objets affectés 
tournent autour de l’objet d’attraction. Par exemple, si vous activez les axes X et Y, l’objet 
tourne dans le plan (X,Y). De même, si vous activez les axes Y et Z, l’objet tourne dans 
le plan (Y,Z).
Axe de perche : ce paramètre n’est disponible que si vous activez les axes X, Y et Z 
dans le paramètre Inclure. Comme tous les points sont à une distance fixe de l’objet 
cible ou attracteur (l’axe de perche), vous pouvez visualiser l’objet sur une sphère 
représentant toutes les orbites possibles, l’objet cible étant situé au centre de cette 
sphère. Le paramètre Axe de perche définit les deux points sur la sphère par lesquels 
l’orbite doit passer. Pour en savoir plus sur ce paramètre, voir « En orbite » à la page 514.Chapitre 5 Utilisation des comportements 527
Direction : menu local permettant de décider le sens de rotation des objets 
(sens des aiguilles d’une montre ou inverse).
Comportements connexes
« Attiré vers, », « Attracteur, », « Dérive attiré vers, », « Attracteur de dérive, », « En 
orbite, », « Ressort ».
Vent
Appliquez ce comportement à un objet pour en animer la position et le déplacer 
dans la direction indiquée. Contrairement au comportement Lancer, la vitesse choisie 
pour le comportement Vent correspond à une force continue, ses paramètres pouvant 
être animés avec des images clés pour obtenir des changements graduels de vitesse 
et de direction.
En comparaison du comportement Lancer, l’avantage de ce comportement est évident 
si vous souhaitez modifier la vitesse de l’objet en cours d’animation. Vous pouvez soit 
appliquer un autre comportement (Rendre aléatoire ou Pente), soit animer le paramètre 
Vitesse du comportement Vent avec des images clés pour modifier la vitesse et la direction 
de l’objet. Il est en revanche impossible d’effectuer des changements graduels de vitesse 
et de direction avec le comportement Lancer.
Commandes disponibles dans la palette
Remarque : la palette vous permet de préciser la direction et la vitesse du comportement 
Vent en faisant glisser une flèche à l’intérieur d’une zone circulaire. Le sens de la flèche 
détermine la direction du mouvement selon les axes X et Y, alors que sa longueur définit la vitesse. Un curseur situé à droite vous permet de déterminer l’échelle des commandes disponibles dans la palette, ce qui augmente ou diminue leur effet sur l’objet.
Appuyez sur la touche Maj lors du glissement de la flèche pour limiter le mouvement 
à un angle de 45 degrés. Appuyez sur la touche Commande pour changer le sens de 
la flèche sans modifier sa longueur.
Commandes gérant le sens et la 
vitesse du vent.
Réglage de l’échelle des commandes de la palette.528 Chapitre 5 Utilisation des comportements
Affiché en haut de la palette, le bouton 3D vous permet d’utiliser la flèche centrale 
pour définir la direction dans laquelle l’objet est soufflé par le vent en 3D. Le curseur 
Vitesse (à gauche de la palette) vous permet alors d’augmenter ou de réduire la vitesse 
à laquelle l’objet est déplacé.
Remarque : la vitesse maximale qu’il vous est possible de fixer dans la palette ne 
correspond pas à la vitesse maximale autorisée. Vous pouvez en effet saisir des valeurs 
plus élevées pour le paramètre Vitesse dans l’onglet Comportements de l’Inspecteur.
Paramètres dans l’Inspecteur
Affecter les sous-objets : ce paramètre apparaît lorsque vous appliquez ce comportement à un objet contenant plusieurs objets, comme un groupe, un émetteur de particules, 
un réplicateur ou une couche de texte. Si vous cochez cette case, tous les objets constituant l’objet parent sont affectés de manière individuelle. Dans le cas contraire, tous les 
objets contenus dans l’objet parent sont affectés simultanément par le comportement, 
comme s’ils ne faisaient qu’un.
Densité de l’air : curseur et curseur de valeur déterminant la vitesse d’accélération de 
l’objet (selon l’axe X, Y ou Z) lors d’un changement de vitesse. Des valeurs peu élevées 
(simulant une faible densité de l’air) ont un impact moins important lorsque l’objet est 
poussé : son accélération prend donc plus de temps. Quant aux valeurs élevées (air plus 
dense), elles sont plus efficaces et poussent l’objet pour qu’il accélère plus rapidement.
Vélocité : curseur et curseur de valeur déterminant la vitesse (selon l’axe X, Y ou Z) 
à laquelle l’air simulé souffle sur l’objet. Des valeurs élevées accélèrent l’animation.
Comportements connexes
« Trajectoire d’animation, », « Gravité, », « Animation aléatoire, », « Lancer ».
Exemples de comportements
Les exemples suivants illustrent diverses possibilités de combinaisons de groupes 
de comportements pour obtenir toute une variété d’effets.
Réglage de la vitesse
du vent.
Réglage de la direction
du vent selon
les axes X, Y et Z.Chapitre 5 Utilisation des comportements 529
Exemple 1 : création d’un générique animé
Dans cet exemple, plusieurs comportements Animation standard sont utilisés pour créer 
les éléments d’une séquence de générique. À l’arrière-plan, le plan s’ouvre en fondu, 
puis des objets graphiques apparaissent en fondu, pivotent, grossissent, pour finalement 
traverser l’écran.
Pour créer les éléments animés d’un séquence de générique :
1 Disposez les deux premières couches graphiques de façon à déterminer leur position 
dans votre composition.
Si vous souhaitez suivre cet exemple, utilisez le fichier « dolphin full.mov » situé dans 
le dossier /Bibliothèque/Application Support/Final Cut Studio/Motion/Sample Media/
National Geographic et le fichier « circleText.psd » placé dans le dossier /Bibliothèque/
Application Support/Final Cut Studio/Motion/Sample Media/Graphicsde votre ordinateur. 
Positionnez alors la couche « circleText » au-dessus du plan du dauphin dans la liste 
de couches.
Remarque : si vous utilisez le plan du dauphin, déplacez la tête de lecture sur 
l’image 150, puis appuyez sur les touches Commande + Option + O pour marquer la 
plage de lecture. Le projet est alors lu en boucle depuis la fin du plan.
2 Tout en lisant le projet (appuyez sur les touches Commande + Barre d’espace), sélectionnez 
ces deux couches dans la liste de couches, cliquez sur l’icône Ajouter comportement 
dans la barre d’outils, puis choisissez Animation standard dans le menu local et Fondu 
entrant/sortant dans le sous-menu pour appliquer ce comportement aux deux couches 
simultanément.
Si vous sélectionnez plusieurs objets, la barre de 
titre de la palette indique « Sélection multiple ».530 Chapitre 5 Utilisation des comportements
3 Tout en maintenant la touche Commande enfoncée, cliquez sur les deux comportements 
dans la liste de couches, puis faites glisser vers la droite la pente grisée située à gauche 
de la palette Fondu entrant/sortant, afin d’allonger l’effet de fondu entrant.
La barre de titre de la palette indique Sélection multiple pour vous rappeler que vous 
modifiez deux comportements simultanément.
4 Faites glisser le plus à droite possible la pente grisée de droite jusqu’à ce qu’elle forme 
un bord vertical sans ombre. 
L’effet de fondu sortant est ainsi éliminé et les couches demeurent à l’écran pour 
le reste de leur durée.
5 Sélectionnez la couche « circleText », cliquez sur l’icône Ajouter comportement de 
la barre d’outils, choisissez Animation standard dans le menu local, puis Rotation 
dans le sous-menu.
6 Dans la palette Rotation, cliquez en haut du cercle, puis faites glisser le pointeur dans 
le sens contraire des aiguilles d’une montre afin de régler la vitesse et la direction de 
la rotation.
7 Alors que la couche « circleText » est sélectionnée, appuyez sur les touches 
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8 Repositionnez la couche dupliquée dans le Canevas, appuyez sur la touche Maj, 
puis faites glisser l’une de ses poignées d’angle pour la remettre à l’échelle.
9 Alors que la couche dupliquée est sélectionnée, cliquez sur l’icône Ajouter comportement 
de la barre d’outils, choisissez Animation standard dans le menu local, puis Trajectoire 
d’animation dans le sous-menu.
La couche se déplace depuis sa position d’origine vers la droite du Canevas, puis au-delà. 
Utilisez le paramètre Direction du comportement Trajectoire d’animation pour changer 
la direction dans laquelle la couche se déplace sur sa trajectoire. Ce paramètre n’est 
disponible que dans l’Inspecteur.
10 Ouvrez l’Inspecteur et cliquez sur l’onglet Comportements. Choisissez Inverser dans 
le menu local Direction.
La couche se déplace désormais de droite à gauche.
11 Dans la mini-Timeline (juste sous le Canevas), faites glisser la fin du comportement 
Trajectoire d’animation vers la gauche jusqu’à ce que sa durée atteigne 200 images.532 Chapitre 5 Utilisation des comportements
La couche se déplace plus vite le long de sa trajectoire.
Vous pouvez également raccourcir la trajectoire en rapprochant son point de départ 
dans le Canevas.
Remarque : vous avez également la possibilité de modifier la forme de la trajectoire 
en lui ajoutant des points ou en sélectionnant une forme prédéfinie, telle qu’une ellipse 
ou un rectangle. Pour en savoir plus, voir « Trajectoire d’animation » à la page 450.
12 Alors que la couche dupliquée est sélectionnée, cliquez sur l’icône Ajouter comportement 
de la barre d’outils, choisissez Animation standard dans le menu local, puis Grossir/
Rétrécir dans le sous-menu.
13 Dans l’onglet Comportements, choisissez « Pente constante jusqu’à la valeur finale » 
dans le menu local Incrémentation du comportement Grossir/Rétrécir, puis réglez 
le paramètre « Changer la taille de » sur 125 %.
Au lieu de grossir indéfiniment, la couche est désormais redimensionnée à 125 % de 
sa taille d’origine.
Exemple 2 : utilisation des comportements de simulation Gravité 
et Collision sur les bords
Le comportement Gravité permet de faire tomber un objet au fil du temps, à une vitesse 
définie par le paramètre Accélération. À moins de lui avoir appliqué d’autres comportements (comme Collision sur les bords), l’objet continue à tomber au-delà du bord infé-
rieur du Canevas (ou de son bord supérieur, si vous avez utilisé une valeur négative 
pour le paramètre Accélération). Dans cet exemple, un groupe constitué de quatre 
couches (des cercles) est utilisé pour illustrer l’utilisation des comportements Gravité 
et Collision sur les bords.
Remarque : bien que vous puissiez appliquer des comportements Simulation à des objets 
distincts, ils révèlent tout leur intérêt lorsque vous les utilisez sur des groupes d’objets. 
Certains comportements Simulation, tels que Vortex, nécessitent l’existence d’un autre 
objet dans le projet pour avoir le moindre effet. En effet, si vous appliquez le comportement Vortex à un objet, vous avez besoin d’un autre objet pour que le premier se mette 
à tourner autour. La situation est identique avec le comportement En orbite.
Cet exemple utilise un contenu fourni avec Motion. Vous pouvez donc le suivre pas 
à pas. Dans ce cas, le comportement Gravité est appliqué au groupe (« cercles 1 ») 
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Pour utiliser le comportement Gravité :
1 Faites glisser le fichier « orangeCircles.psd » depuis le dossier /Bibliothèque/Application 
Support/Final Cut Studio/Motion/Sample Media/Graphics vers le Canevas tout en maintenant le bouton de la souris enfoncé jusqu’à ce qu’un menu déroulant apparaisse.
2 Choisissez Importer toutes les couches dans ce menu déroulant.
Le fichier Photoshop importé est constitué d’un seul groupe de quatre couches. Chaque 
couche est un cercle de couleur semi-transparent. Comme vous avez sélectionné 
la commande « Importer toutes les couches » lors de l’importation, les couches sont 
importées sous forme de couches séparées au sein d’un même groupe.
3 Double-cliquez sur la couche « orangeCircles », saisissez « cercles 1 », puis appuyez 
sur Retour.
La couche est renommée.
4 Appliquez le comportement Gravité au groupe « cercles 1 ».
La trajectoire d’animation créée par le comportement Gravité apparaît dans le Canevas 
et le groupe de cercles tombe lorsque vous lisez le projet. Comme ce comportement 
est appliqué au groupe, toutes les couches du groupe tombent à la même vitesse.
Comportement Gravité appliqué à un groupe 
(et non aux couches qui constituent ce groupe)534 Chapitre 5 Utilisation des comportements
5 Pour augmenter la vitesse de chute des couches, faites glisser vers la droite le curseur 
Accélération affiché par la palette Gravité ou l’Inspecteur (dans cet exemple, la valeur 
du paramètre Accélération est réglée sur 100).
Remarque : vous pouvez saisir une valeur négative dans le champ de valeur Accélération 
de l’Inspecteur afin que les couches s’élèvent, au lieu de tomber.
Pour utiliser le comportement Collision sur les bords :
1 Appliquez le comportement « Collision sur les bords » au groupe « cercles1 ».
2 Dans la palette « Collision sur les bords » (ou l’Inspecteur), désactivez la case « Affecter 
les sous-objets ».
Si vous appliquez le comportement « Collision sur les bords » à un groupe en désactivant le paramètre « Affecter les sous-objets », l’ensemble du groupe « rebondit » sur le 
bord inférieur de l’écran, au niveau du point d’ancrage du groupe.
3 Cochez la case « Affecter les sous-objets » dans la palette « Collision sur les bords » 
(ou l’Inspecteur).
Remarque : les paramètres disponibles dans l’Inspecteur pour le comportement « Collision 
sur les bords » comportent également des commandes Bords actifs permettant d’activer et 
de désactiver les bords de l’écran (ou de l’espace tridimensionnel) contre lesquels l’objet 
entre en collision. Par défaut, un objet rebondit sur tous les bords de l’écran.
Si vous appliquez le comportement « Collision sur les bords » à 
un groupe en désactivant le paramètre « Affecter les sous-objets », 
l’objet (le groupe) rebondit sur le bord de l’écran, au niveau de son 
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Lorsque le bord inférieur de chaque cercle entre en collision avec le bord inférieur 
de l’écran, le cercle concerné rebondit vers le haut.
Au cours de la lecture du projet, chaque cercle rebondit vers le haut et le bas.
D’autres comportements Simulation intègrent le paramètre « Affecter les sous-objets ». 
Il s’agit notamment des comportements « Aligner sur l’animation », Glissement, Gravité, 
Animation aléatoire et Mouvement de rotation.
Exemple 3 : utilisation des comportements En orbite et Vortex
Le comportement En orbite fait tourner un objet en orbite autour d’un autre objet en 
décrivant un cercle parfait. Vous pouvez d’ailleurs modifier ses paramètres pour créer 
une animation plus intéressante. Quant au comportement Vortex, il est l’exact opposé. 
Alors que le comportement En orbite fait tourner un objet autour d’un objet cible, 
le comportement Vortex exerce une force sur tous les objets entourant l’objet auquel 
il est appliqué. Les exemples suivants utilisent le même groupe de couches (les cercles 
de la rubrique précédente, « Exemple 2 : utilisation des comportements de simulation 
Gravité et Collision sur les bords » à la page 532. Toutefois, les couches sont repositionnées dans le Canevas.
Utilisation du comportement En orbite
Pour créer une animation à l’aide du comportement En orbite, vous devez indiquer 
un objet cible autour duquel les autres objets tournent. Pour ce faire, faites glisser 
l’objet choisi vers le cadre d’objet présent dans l’onglet Comportements 
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Pour utiliser le comportement En orbite :
1 Dans la liste de couches, cliquez sur le bouton Ajouter (+) pour créer un nouveau groupe.
2 Tout en maintenant la touche Option enfoncée, faites glisser la couche « sm circle » 
vers le nouveau groupe.
Une copie de la couche est ajoutée au nouveau groupe.
3 Renommez la couche « sm circle » en « cercle central », puis positionnez-la au centre 
du Canevas.
4 Appliquez le comportement En orbite au groupe « circles 1 ».
Le comportement En orbite est appliqué au groupe de cercles (« circles 1 ») dans 
le projet. La couche « cercle central » présente au centre du Canevas est située dans 
un groupe différent des autres couches.
Lors de la première application du comportement En orbite, il ne se passe rien. En effet, 
vous devez tout d’abord indiquer la couche autour de laquelle le groupe doit tourner.Chapitre 5 Utilisation des comportements 537
5 Faites glisser un objet, ici la couche « cercle central », depuis l’onglet Couches 
et déposez-la dans le cadre d’objet affiché dans la palette En orbite ou l’Inspecteur.
Cet objet devient l’objet cible autour duquel les autres objets tournent en orbite.
Vous pouvez également faire glisser l’objet cible sur le comportement En orbite 
dans l’onglet Couches.
Important : il peut s’avérer délicat de faire glisser un objet dans un cadre : veillez à cliquer 
sur le nom de l’objet dans l’onglet Couches et à faire glisser immédiatement la couche 
vers le cadre (sans relâcher le bouton de la souris). Le comportement doit alors rester 
actif, même si vous cliquez sur un autre objet dans l’onglet Couches. Si vous cliquez 
sur l’objet que vous souhaitez faire glisser vers le cadre d’objet et que vous relâchez 
le bouton de la souris, l’objet est sélectionné, mais les paramètres du comportement 
ne sont plus affichés. Ce comportement est valable pour tous les cadres, cadres d’image 
et de source du masque compris. Pour visualiser à nouveau les paramètres du comportement En orbite, vous devez le sélectionner.
6 Assurez-vous que la case « Affecter les sous-objets » est cochée dans la palette 
En orbite (ou l’Inspecteur).
Lorsque cette case est cochée, tous les objets situés au sein du groupe tournent autour 
de l’objet cible.
D’autres comportements Simulation utilisent également un objet cible. Il s’agit notamment 
des comportements Attiré vers, Attracteur de dérive, « Repousser à partir de » et Ressort.
Faites glisser la couche dans le cadre 
Objet. Relâchez le bouton de la souris
lorsqu’une flèche courbe apparaît 
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Utilisation du comportement Vortex
Pour créer une animation à l’aide du comportement Vortex, vous devez exercer une force 
sur tous les objets entourant l’objet auquel le comportement Vortex est appliqué. 
Vous pouvez d’ailleurs indiquer si Tous les objets, seulement les Objets connexes ou 
des Objets spécifiques sont affectés par ce comportement. L’exemple suivant utilise 
le même projet que dans l’exemple précédent.
Pour utiliser le comportement Vortex :
1 Sur la base de l’exemple précédent, supprimez le comportement En orbite du projet.
2 Tout en maintenant la touche Option enfoncée, faites glisser la couche « cercle central » 
dans le groupe « orangeCircles » dans la liste de couches.
Remarque : si vous le souhaitez, renommez la couche « cercle central » copiée. 
Dans cet exemple, les deux couches (l’originale et la copie) portent le même nom : 
« cercle central ».
3 Appliquez le comportement Vortex à la couche du « cercle central » du groupe situé 
au-dessus du groupe des cercles.
Par défaut, le paramètre Affecter du comportement Vortex est réglé sur Objets connexes. 
Lorsque cette option est activée, tous les objets situés dans le même groupe que l’objet 
auquel le comportement est appliqué tournent autour de cet objet. Le cercle étant 
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4 Dans la palette Vortex, choisissez Tous les objets dans le menu local Affecter.
Une fois que vous avez choisi cette option, tous les objets du projet (quel que soit 
le groupe dans lequel ils se trouvent) sont affectés et tournent autour de l’objet auquel 
le comportement Vortex est appliqué.
Lorsque vous utilisez le comportement Vortex, vous disposez de deux méthodes pour 
créer une animation dans laquelle certains objets seulement (et non tous les objets du 
projet) tourbillonnent autour de l’objet auquel le comportement Vortex est appliqué :
Â Réglez le paramètre Affecter sur Objets spécifiques, puis sélectionnez chaque couche 
que vous souhaitez faire tourner autour de la couche cible.
Â Déplacez l’objet auquel le comportement Vortex est appliqué dans le même groupe 
que les couches des cercles, puis réglez le paramètre Affecter sur Objets connexes.
Une fois que vous avez choisi le réglage Tous les 
objets, toutes les couches du projet tourbillonnent 
autour de la couche à laquelle le comportement 
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Pour affecter seulement des objets spécifiques :
1 Dans la palette ou l’Inspecteur, réglez le paramètre Affecter du comportement Vortex 
sur Objets spécifiques (sans déplacer les couches).
2 Si ce paramètre n’apparaît pas, ouvrez l’onglet Comportements de l’Inspecteur.
Parmi les paramètres du comportement, une liste Objets modifiés apparaît.
3 Pour appliquer le comportement Vortex à certains objets, faites glisser ces objets 
de l’onglet Couches vers la liste Objets modifiés. Comme pour les cadres d’objet, 
vous pouvez déposer un objet dès qu’une flèche courbe apparaît au-dessus de la liste.
Au fur et à mesure que vous ajoutez des couches, leur nom et le nom du groupe qui 
les contient apparaissent dans la liste. Si vous faites glisser un groupe sur la liste Objets 
modifiés, toutes les couches de ce groupe sont ajoutées à la liste.
Remarque : vous pouvez faire glisser des objets de n’importe quel groupe d’un projet 
vers la liste Objets modifiés. Pour supprimer un objet de la liste, il vous suffit de 
le sélectionner, puis de cliquer sur Supprimer.
Toutes les couches ajoutées à la liste Objets modifiés tourbillonnent autour de la couche 
à laquelle le comportement Vortex est appliqué.Chapitre 5 Utilisation des comportements 541
Pour affecter seulement les objets connexes :
1 Dans l’onglet Couches, déplacez l’objet auquel le comportement Vortex est appliqué 
dans le groupe contenant les objets à affecter. Dans ce cas, faites glisser l’objet « cercle 
central » du Groupe 1 vers le groupe « circles 1 ».
2 Dans l’Inspecteur ou la palette, réglez le paramètre Affecter du comportement Vortex 
sur Objets connexes.
Les objets du groupe tournent autour de l’objet cible.
Remarque : d’autres comportements Simulation utilisent également le paramètre 
Affecter. Il s’agit notamment des comportements Attracteur, Repousser et Attracteur 
de dérive.
Exemple 4 : création d’une animation d’horloge
Dans cet exemple, deux comportements Paramètre servent à créer une horloge animée. 
En agençant correctement les couches et leur point d’ancrage, vous pouvez animer 
rapidement et très simplement chaque élément à l’aide des comportements Vitesse 
et Osciller.
Remarque : les fichiers source de cet exemple ne sont pas intégrés au dossier Sample 
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Pour créer une animation d’horloge :
1 Placez les couches graphiques représentant des aiguilles, un cadran et un pendule dans 
le Canevas de façon à symboliser une horloge.
Les aiguilles viennent en haut, le cadran au milieu et le pendule en fond.
Par défaut, le point d’ancrage se trouve au centre de chaque objet. Avant d’ajouter 
des comportements pour animer ces couches, vous devez déplacer les points d’ancrage 
et animer les couches comme il est nécessaire. Dans cet exemple, les aiguilles doivent 
pivoter autour du centre du cadran et non de leur propre centre, le pendule devant 
quant à lui se balancer à partir de son point supérieur.
2 Choisissez l’outil Ajuster le point d’ancrage, puis déplacez les points d’ancrage des deux 
couches des aiguilles et de la couche du pendule au centre du cadran.
Dès lors que votre composition est prête pour l’animation, il ne vous reste plus qu’à 
appliquer des comportements à chaque couche.
3 Sélectionnez la couche de l’aiguille des minutes, ouvrez l’onglet Propriétés de l’Inspecteur, 
cliquez sur le paramètre Rotation tout en maintenant la touche Contrôle enfoncée, 
puis choisissez Vitesse dans le menu contextuel.Chapitre 5 Utilisation des comportements 543
Le comportement Vitesse est appliqué au paramètre Rotation.
4 Dans l’onglet Comportements, réglez le paramètre Vitesse sur –49.
De cette façon, l’aiguille des minutes tourne à un rythme régulier dans le sens des 
aiguilles d’une montre.
5 Sélectionnez la couche de l’aiguille des heures, cliquez sur le paramètre Rotation tout 
en maintenant la touche Contrôle enfoncée dans l’onglet Propriétés, puis choisissez 
Vitesse dans le menu contextuel.
6 Dans l’onglet Comportements, réglez le paramètre Vitesse sur –4.544 Chapitre 5 Utilisation des comportements
Lorsque vous lisez le projet à ce stade, vous voyez que l’aiguille des heures tourne 
dans le sens des aiguilles d’une montre de manière continue, tout comme l’aiguille 
des minutes, mais beaucoup plus lentement, reproduisant le mouvement normal 
d’une horloge.
∏ Astuce : pour que les aiguilles de l’horloge donnent l’impression d’avancer par « cran », 
vous pouvez appliquer le comportement Quantifier au paramètre Rotation 
des aiguilles, puis réglez le paramètre Taille du pas pour l’adapter à l’animation.
Il est temps de s’occuper du pendule. dont vous devez déjà avoir ajusté le point 
d’ancrage tout en haut. De cette façon, la couche inférieure du pendule pourra 
se balancer correctement. 
7 Sélectionnez la couche du pendule, cliquez sur le paramètre Rotation tout en maintenant 
la touche Contrôle enfoncée dans l’onglet Comportements, puis choisissez Osciller 
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8 Dans l’onglet Comportements, réglez sur 20 le paramètre Amplitude du comportement 
Osciller.
La couche du pendule oscille de manière beaucoup plus raisonnable. 
9 Augmentez le paramètre Vitesse à 50.
Vous obtenez un mouvement rapide habituel pour une horloge. Et le tour est joué !6
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6 Images et clés et courbes
Que vous souhaitiez envoyer des plans en l’air pour 
qu’ils traversent l’écran ou animer des réglages de filtres 
individuels à la volée, les images clés vous permettent 
de modifier n’importe quel paramètre dans le temps 
avec une précision extrême. 
Ce chapitre traite de la création et de la modification d’images clés dans Motion. 
Si les comportements sont parfaits pour appliquer instantanément des mouvements 
ou des effets complexes à un objet, les images clés apportent une précision et une 
flexibilité supplémentaires. Les images clés vous garantissent qu’un événement donné 
se produit précisément sur l’image que vous avez choisie. 
La plupart des effets courants ont recours à des images clés. Chaque fois qu’un mouvement ou un effet est synchronisé avec un rythme musical ou un mot en particulier dans 
la bande son, l’image clé est l’outil idéal pour remplir cette tâche. De plus, tous les effets 
dans lesquels plusieurs objets sont affectés de manière coordonnée sont en général 
le résultat d’images clés.548 Chapitre 6 Images et clés et courbes
Qu’est-ce que l’animation avec des images clés ?
L’animation avec des images clés est le processus visant à affecter une valeur de 
paramètre spécifique à un objet à un moment bien précis. Par exemple, vous souhaitez 
peut-être qu’un plan soit mis à l’échelle pour remplir l’écran pendant exactement cinq 
secondes dans votre projet. Lorsque vous définissez plus d’une image clé, Motion 
génère des images intermédiaires, ce qui offre un changement régulier du paramètre 
dans le temps. C’est ce qu’on appelle une interpolation. Par exemple, si vous souhaitez 
que la couleur d’un titre passe du vert au bleu, vous devez définir deux images clés 
à deux points différents dans le temps. La première devrait définir la couleur du texte 
comme verte et la deuxième image clé devrait définir la couleur sur le bleu. Motion 
fait automatiquement en sorte que ces images entre ces deux points passent 
progressivement du vert au bleu. 
Motion vous permet de définir les paramètres des images clés tels que les valeurs des 
couleurs, la position, la rotation, l’opacité et presque tous les paramètres de l’application.
Animations dans Motion
À plusieurs reprises, Motion vous permet de créer et de modifier des images clés et 
les valeurs entre chaque image, qui sont représentées par des courbes d’animation. 
Par exemple, vous pouvez animer des propriétés de base telles que l’échelle, la rotation 
et la position de l’écran en manipulant simplement l’objet directement dans le Canevas 
lorsque le bouton Enregistrer est activé. 
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Lorsque l’enregistrement est activé, une image clé est créée pour n’importe quel 
paramètre ajusté dans le Canevas, l’Inspecteur ou la palette. Dans la zone de dialogue 
Options d’enregistrement (accessible avec les touches Option + A), vous pouvez activer l’option « Enregistrer les images clés sur les paramètres animés seulement », 
laquelle ajoute uniquement des images clés aux paramètres déjà animés (avec des images clés), même si l’enregistrement est activé. Pour plus d’informations, consultez la 
rubrique « Enregistrement d’images clés sur les paramètres animés uniquement » à la 
page 613.
Vous pouvez également recourir à la palette et à l’Inspecteur pour définir et modifier 
les valeurs de quasiment toutes les options disponibles dans l’application. À chaque 
fois que vous réglez un curseur ou tout autre contrôle, vous pouvez verrouiller cette 
modification sur l’image en cours, créant ainsi une image clé. À partir de là, peu 
importe ce que vous faites, ce paramètre trouve toujours cette valeur précise lors 
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Vous pouvez également visualiser et modifier des images clés dans la Timeline en 
cliquant sur le bouton Afficher/Masquer les images clés. Les images clés apparaissent 
alors sous forme de petits losanges bleus (ou blancs si sélectionnés) en dessous de leur 
objet parent.
Dans l’Éditeur d’images clés, vous pouvez afficher et manipuler un graphique pour 
chaque paramètre de l’application. Encore une fois, les images clés s’affichent sous 
forme de losanges, et les lignes (ou courbes) qui relient les images clés indiquent 
les valeurs des images interpolées.
Vous pouvez filtrer la liste des paramètres de manière à afficher uniquement les canaux 
et les images clés qui vous intéressent.
Bouton Afficher/Masquer les images clés Image clé sélectionnée
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Animation dans le Canevas
La manière la plus simple d’insérer des images clés consiste à modifier les objets 
directement dans le Canevas. Les effets les plus courants que vous pouvez créer à l’aide 
des images clés sont les modifications apportées à l’Échelle, la Rotation et la Position. 
Parmi les paramètres qui peuvent être animés avec des images clés dans le Canevas 
figurent Déformer, Pivot, Ombre portée, Rogner et Quatre angles. Même si bon nombre 
de ces techniques peuvent être également exploitées à l’aide de comportements, 
le recours à des images clés vous offre une flexibilité supplémentaire pour définir 
des valeurs spécifiques sur des images précises.
En règle générale, lorsque vous appliquez des transformations à un objet dans le 
Canevas, l’objet reste dans sa nouvelle position ou garde sa nouvelle forme pendant 
toute la durée où il apparaît. Pour créer un changement dans un objet dans le temps, 
vous devez créer des images clés. Il existe plusieurs moyens de créer des images clés 
lors de l’utilisation du Canevas.
Utilisation du bouton Enregistrer
L’un des moyens les plus simples de créer des images clés consiste à utiliser le bouton 
Enregistrer. Lorsque l’enregistrement est activé, une image clé est créée pour n’importe 
quel paramètre ajusté.
Remarque : si l’enregistrement est activé, des images clés sont créées que vous ajustiez 
l’objet à l’écran, dans la palette ou dans l’Inspecteur.
Lorsque les images clés (Enregistrement) sont activées, les modifications appliquées 
à l’objet sont également appliquées à la position actuelle de la tête de lecture (que 
vous pouvez apercevoir dans la mini-Timeline en bas du Canevas). Une image clé est 
automatiquement ajoutée (même si aucun indicateur n’apparaît). Si vous déplacez 
la tête de lecture sur une nouvelle position et que vous modifiez la forme ou la position 
de l’objet, vous créez une image clé. Motion analyse automatiquement la forme et 
la position de l’objet sur les images entre deux images clés définies.
Important : lorsque l’enregistrement est activé, une image clé rouge apparaît au centre 
de l’objet sélectionné. Lorsque vous déplacez l’objet dans le Canevas, ne cliquez pas sur 
l’image clé au centre de l’objet, car vous sélectionneriez et repositionneriez cette image 
clé au lieu de la position actuelle de l’objet.
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Pour dimensionner un objet dans le temps avec le bouton Enregistrer :
1 Cliquez sur le bouton Enregistrer (ou appuyez sur A) pour activer l’enregistrement 
d’images clés. 
Vous pouvez également sélectionner les options Marquer > Enregistrer l’animation.
2 Sélectionnez un objet dans le Canevas.
3 Déplacez la tête de lecture sur une nouvelle position dans le temps.
4 Redimensionnez l’objet en faisant glisser l’une de ses poignées d’échelle.
5 Cliquez sur le bouton Enregistrer (ou appuyez de nouveau sur A) pour désactiver 
l’enregistrement d’images clés. 
L’objet est mis à l’échelle sur l’intervalle que vous avez défini. De la même manière, 
vous pouvez appliquer des images clés à tous les paramètres de transformation de 
votre objet.
Vous pouvez également cliquer sur l’objet tout en maintenant la touche Contrôle 
enfoncée pour afficher un menu contextuel proposant des options de modification 
des paramètres Pivot, Déformer, Ombre portée, Quatre angles et Rogner. Par exemple, 
choisissez Transformer dans ce menu local pour activer l’affichage des poignées 
d’échelle et de rotation dans le Canevas. Pour en savoir plus sur les transformations 
d’un objet dans le Canevas, reportez-vous à la rubrique « Transformation d’objets et de 
couches dans le Canevas » à la page 291.Chapitre 6 Images et clés et courbes 553
Lorsque le bouton Enregistrer est activé, chaque fois que vous déplacez la tête 
de lecture vers une autre image, toute modification apportée à un objet génère 
automatiquement de nouvelles images clés. Lors de l’animation de la position 
d’un objet, un chemin d’animation est créé.
Remarque : pour pouvoir visualiser les trajectoires d’animation des objets animés avec 
des images clés, assurez-vous que l’option Trajectoire d’animation est bien sélectionnée 
dans le menu local Présentation (dans le coin supérieur droit de la fenêtre principale, 
au-dessus du Canevas).554 Chapitre 6 Images et clés et courbes
Lorsque le bouton Enregistrer est désactivé, toutes les modifications apportées 
s’appliquent globalement à l’animation entière. Par exemple, si un objet est animé 
avec des images clés pour se déplacer du coin inférieur gauche vers le centre de l’écran 
et si vous déplacez l’objet vers la droite lorsque le bouton Enregistrer est désactivé, 
toute la trajectoire se déplace vers la droite.
Remarque : si vous êtes positionné sur une image clé précédemment définie, toutes 
les modifications effectuées s’appliquent à cette image clé et non à la courbe complète, que le bouton Enregistrer soit activé ou non.
Application d’un mouvement à un plan
Déplacer des objets à l’écran est l’essence même de l’animation. Motion fait donc 
en sorte que ces déplacements soient un véritable jeu d’enfant. 
Pour déplacer un objet à travers l’écran :
1 Cliquez sur le bouton Enregistrer (ou appuyez sur A) pour activer l’enregistrement 
d’images clés.
2 Positionnez la tête de lecture sur l’image de départ.
3 Placez l’objet sur une position de départ.
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5 Faites glisser l’objet sur la position finale que vous souhaitez.
6 Cliquez sur le bouton Enregistrer (ou appuyez de nouveau sur A) pour désactiver 
l’enregistrement d’images clés.
Si vous exécutez votre projet, vous observerez que votre objet se déplace de la position 
un à la position deux sur l’intervalle que vous avez défini. Vous pouvez voir la trajectoire 
suivie par l’objet en activant le réglage Trajectoire d’animation dans le menu local 
Présentation au-dessus du Canevas.
Important : lorsque l’enregistrement est activé, vous pouvez choisir d’ajouter uniquement 
des images clés aux paramètres déjà animés d’un objet. Cette option est disponible dans 
la zone de dialogue Options d’enregistrement. Pour plus d’informations, consultez la rubrique « Enregistrement d’images clés sur les paramètres animés uniquement » à la 
page 613.
Manipulation de trajectoires d’animation
Lorsque la trajectoire d’animation est affichée, vous pouvez directement manipuler 
les images clés pour les repositionner et modifier la trajectoire suivie par l’objet. 
Si vous faites glisser une image clé dans le Canevas, le numéro du point de contrôle, 
ainsi que les valeurs des positions X, Y et Z sont affichés dans une petite fenêtre 
d’information au niveau de l’emplacement du pointeur.556 Chapitre 6 Images et clés et courbes
Pour ajouter des images clés à une trajectoire d’animation :
1 Appuyez sur la touche Option tout en cliquant sur la trajectoire.
Un nouveau point d’image clé est alors ajouté. 
2 Faites glisser ce point d’image clé vers une nouvelle position.
Vous avez la possibilité de convertir un point linéaire d’image clé en point de Bézier 
pour créer une trajectoire courbe. Vous pouvez effectuer cette conversion lors de 
la création de l’image clé ou une fois qu’elle est créée.
Pour ajouter une image clé de Bézier à une trajectoire d’animation :
m Appuyez sur la touche Option tout en cliquant sur la trajectoire, puis éloignez immédiatement le curseur du point. 
Un point est alors ajouté et la tangente de Bézier apparaît.
Pour convertir une image clé existante en point de Bézier :
m Appuyez sur la touche Commande tout en cliquant sur l’image clé et éloignez-vous 
du point. 
Des poignées sont ajoutées à l’image clé.
Les points de contrôle de trajectoire d’animation sont modifiés de la même façon 
sous forme de points de Bézier de forme ou de masque. Pour plus d’informations sur 
la manipulation de splines Bézier, consultez la rubrique « Dessin de masques et de 
formes à l’aide de courbes splines de Bézier » à la page 1076.
Animation à l’aide de la palette
Pour animer avec des images clés les paramètres affichés dans la palette, conformez-vous 
à la même procédure que lors de l’animation avec des images clés directement dans 
le Canevas. Par exemple, lorsqu’un objet est sélectionné dans le Canevas, la palette vous 
permet d’accéder rapidement à l’opacité de cet objet. Si vous souhaitez créer un effet 
personnalisé, tel que plonger temporairement une image dans le noir, vous devez animer 
avec des images clés son paramètre Opacité.
Pour animer l’opacité d’un plan :
1 Cliquez sur le bouton Enregistrer (ou appuyez sur A) pour activer l’enregistrement 
d’images clés.
2 Positionnez la tête de lecture sur l’image sur laquelle vous souhaitez commencer le fondu.Chapitre 6 Images et clés et courbes 557
3 Cliquez sur le curseur Opacité dans la palette. 
Même si vous ne modifiez pas la valeur du curseur, le fait de cliquer dessus définit une 
image clé à ce point dans le temps. Ainsi, l’objet reste à son taux d’opacité précédent 
à partir du début du plan jusqu’à la nouvelle image clé ; ensuite l’interpolation vers 
l’image clé suivante commence.
4 Déplacez la tête de lecture vers l’avant jusqu’à un nouveau point dans le temps.
5 Modifiez la valeur d’opacité. 
6 Faites avancer à nouveau la tête de lecture.
7 Déplacez à nouveau le curseur d’opacité.
8 Cliquez sur le bouton Enregistrer (ou appuyez de nouveau sur A) pour désactiver 
l’enregistrement d’images clés.
Images clés au début et à la fin de la courbe 
Lorsque vous commencez à ajouter des images clés, vous ordonnez à Motion 
de modifier automatiquement les images intermédiaires en vue d’interpoler l’effet 
obtenu. Mais quelles valeurs sont utilisées pour les images avant la première image 
clé et après la dernière ? 
Par défaut, lorsque vous ajoutez votre première image clé, la même valeur est 
appliquée en avant et en arrière, jusqu’au début et la fin du plan (comme si vous 
n’aviez pas ajouté d’image clé).
Une fois que vous avez ajouté une deuxième image clé, l’effet commencera à changer 
dans le temps. Mais les images avant cette première image clé restent sur la valeur 
de cette première image clé. De même, les images après la dernière image clé restent 
configurées sur la dernière valeur définie. 
Vous pouvez ignorer ce comportement par défaut pour créer des boucles et d’autres 
motifs grâce aux sous-menus Avant la première image clé et Après la dernière image 
clé, comme décrit dans la rubrique « Extrapolation » plus loin dans ce chapitre.558 Chapitre 6 Images et clés et courbes
Animation de filtres
En plus de modifier les attributs de base d’un plan, les images clés peuvent être utilisées 
pour modifier presque tous les paramètres de l’application. Si le bouton Enregistrer 
est activé, il est possible d’animer avec des images clés tous les paramètres affichés dans 
la palette. Par exemple, lorsque vous appliquez des filtres à des objets, la palette affiche 
tous les paramètres les plus importants. Grâce aux images clés, vous pouvez animer 
ces paramètres. Ainsi, vous pouvez créer un plan qui devient de plus en plus flou ou 
animer la largeur d’un effet biseau.
Pour animer un filtre :
1 Sélectionnez un objet à modifier.
2 Appliquez un filtre à cet objet.
La palette est actualisée et affiche les paramètres de ce filtre. Pour en savoir plus sur 
l’application de filtres, voir « Utilisation de filtres » à la page 910.
3 Cliquez sur le bouton Enregistrer (ou appuyez sur A) pour activer l’enregistrement 
d’images clés.
4 Positionnez la tête de lecture à l’endroit où vous souhaitez que l’effet commence à changer.
5 Dans la palette, réglez le curseur du paramètre que vous souhaitez animer sur 
une valeur de départ.
6 Positionnez la tête de lecture sur l’image sur laquelle vous souhaitez que l’effet arrête 
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7 Réglez le curseur sur une nouvelle valeur.
8 Cliquez sur le bouton Enregistrer (ou appuyez de nouveau sur A) pour désactiver 
l’enregistrement d’images clés.
Le filtre est modifié dans le temps selon vos réglages. La même technique s’applique 
à tous les paramètres de n’importe quel filtre affiché dans la palette.
Animation de comportements
En plus d’animer des paramètres de filtres, vous pouvez également animer des 
comportements. L’animation de comportements peut sembler un peu complexe au 
premier abord car la plupart des comportements changent déjà, mais si vous combinez 
ces fonctions, vous pouvez améliorer de façon significative l’utilité des comportements. 
Par exemple, vous souhaitez peut-être animer un comportement Animation aléatoire 
pour commencer un mouvement aléatoire subtil qui deviendra de plus en plus 
prononcé au fur et à mesure que l’effet s’exécute. Ou, vous désirez appliquer un 
comportement Gravité, mais vous souhaitez que l’objet commence à tomber cinq 
secondes après le début du plan. Les images clés vous permettent de manipuler 
les paramètres spécifiques de chaque comportement.
Remarque : dans Motion, vous pouvez élaborer des images clés à partir de tous 
les comportements appliqués à un objet, à l’aide de la commande Convertir en images 
clés du menu Objet. Pour plus d’informations, consultez la rubrique « Conversion de 
comportements en images clés » à la page 441.
Pour animer un comportement :
1 Sélectionnez un objet dans le Canevas.
2 Appliquez un comportement.
3 Cliquez sur le bouton Enregistrer (ou appuyez sur A) pour activer l’enregistrement 
d’images clés. 
4 Placez la tête de lecture sur l’image sur laquelle vous souhaitez que l’effet commence 
à changer.
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5 À l’aide de la palette, définissez les réglages du comportement.
6 Déplacez la tête de lecture sur une nouvelle position dans le temps.
7 Ajustez de nouveau les réglages du comportement.
8 Cliquez sur le bouton Enregistrer (ou appuyez de nouveau sur A) pour désactiver 
l’enregistrement d’images clés.
Combinaison des comportements et des images clés 
Comme il est possible d’ajouter des images clés à un objet auquel un ou plusieurs 
comportements ont déjà été appliqués, ces deux méthodes peuvent parfois entrer 
en conflit. Par exemple, vous pouvez appliquer un comportement Lancer vers le coin 
supérieur gauche, et en même temps ajouter des images clés qui ordonnent à l’objet 
de se déplacer vers la droite. Que se passe-t-il alors ?
La manière dont Motion gère ce genre de conflits consiste à cumuler les instructions, 
vous offrant une combinaison des deux séquences d’instructions. Dans l’exemple 
ci-dessus, l’objet se déplacerait vers le coin supérieur gauche, mais n’irait pas aussi loin 
puisque les images clés le poussent dans la direction opposée.
Plus la vitesse du Lancer est importante, plus elle surpasse les images clés et inversement.
Trajectoire d’animation du comportement Trajectoire d’animation de l’image clé
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Une fois que vous maîtrisez le fonctionnement, vous pouvez utiliser cette méthode pour 
améliorer et contrôler les effets des comportements. Par exemple, vous pouvez appliquer 
un comportement Gravité qui entraîne la chute d’un objet vers le bas de l’image, mais 
recourir à une image clé pour modifier la position de l’objet et le faire se déplacer à 
travers l’écran de gauche à droite. Ainsi, vous pouvez créer l’effet de l’objet qui tombe 
et se déplace en même temps. Vous pouvez également appliquer un comportement 
Fondu entrant/Fondu sortant à un objet, mais utiliser les images clés de son paramètre 
Opacité, afin de limiter son opacité maximale à 80 %. Le plan permet toujours le fondu 
entrant et sortant, et vous pouvez continuer à modifier les attributs du comportement, 
mais l’objet ne dépasse jamais la valeur d’opacité définie par les images clés.
Une méthode de gestion des comportements et des images clés consiste à convertir 
les comportements en images clés. Pour en savoir plus sur la transformation 
de comportements en images clés, consultez la rubrique « Conversion de comportements en images clés » à la page 441.
Animation à l’aide de l’Inspecteur
Même si vous pouvez animer un grand nombre d’attributs à l’aide de la palette, 
plusieurs autres paramètres sont uniquement accessibles via l’Inspecteur. Tous les 
onglets de l’Inspecteur contiennent des paramètres pouvant être animés avec des 
images clés. Ainsi, vous pouvez animer la position et la forme d’un masque, la couleur 
et les styles d’un objet texte, ou les diverses options à l’intérieur des générateurs. 
Les paramètres qui peuvent être animés avec des images clés dépendent de l’objet 
sélectionné et des effets qui lui sont appliqués.
Vous pouvez animer des paramètres dans l’Inspecteur grâce au bouton Enregistrer 
et à la tête de lecture de la mini-Timeline, comme s’il s’agissait de paramètres dans 
le Canevas ou la palette.
Pour animer les paramètres dans l’Inspecteur :
1 Sélectionnez l’objet que vous souhaitez animer avec des images clés dans le Canevas.
2 Cliquez sur le bouton Enregistrer (ou appuyez sur A) pour activer l’enregistrement 
d’images clés.
3 Placez la tête de lecture sur l’image à partir de laquelle vous souhaitez que l’effet 
commence à changer.
4 Affichez l’Inspecteur en cliquant sur l’onglet ou en rajustant la présentation de l’écran 
pour qu’il inclue l’Inspecteur. Pour en savoir plus sur les présentations, consultez 
la rubrique « Présentations prédéfinies » à la page 25.562 Chapitre 6 Images et clés et courbes
5 Cliquez sur l’onglet Inspecteur qui contient le paramètre que vous souhaitez modifier 
(les filtres dans cet exemple).
6 Définissez le paramètre sur la valeur de départ.
7 Déplacez la tête de lecture sur une nouvelle position.
8 Dans l’Inspecteur, configurez le paramètre sur une nouvelle valeur.
9 Cliquez de nouveau sur le bouton Enregistrer (ou appuyez sur A) pour désactiver 
l’enregistrement.
Le paramètre change désormais avec le temps.Chapitre 6 Images et clés et courbes 563
Menu Animation
L’animation dans l’Inspecteur offre des options supplémentaires, comme la possibilité 
de supprimer ou de réinitialiser les informations relatives aux images clés. Vous pouvez 
également naviguer entre les images clés dans l’Inspecteur. Chaque paramètre qui peut 
être animé avec des images clés contient un menu Animation. Si un paramètre ne 
propose pas ce menu, il ne peut pas être animé.
Activer l’animation : cet élément de menu reste inaccessible jusqu’à ce que l’animation 
soit appliquée au paramètre, soit en utilisant le bouton Enregistrer, soit en ajoutant 
directement une image clé. Une fois que le canal comporte au moins un ensemble 
d’images clés, l’élément de menu est automatiquement renommé Désactiver l’animation. 
Si vous la désactivez à ce stade, vous masquez en fait les images clés que vous avez définies et vous restaurez le paramètre à sa valeur par défaut. Toutefois, les images clés 
ne sont pas supprimées. Si vous sélectionnez à nouveau Activer l’animation, le paramètre 
est restauré à son état le plus récent lié aux images clés.
Réinitialiser le paramètre : supprime toutes les images clés et les réglages pour ce 
paramètre. La valeur du paramètre est réinitialisée sur sa valeur par défaut.
Ajouter une image clé : ajoute une image clé sur l’image actuelle dans le projet. 
Si la tête de lecture est positionnée sur une image à laquelle une image clé a déjà été 
ajoutée, cette commande du menu est inaccessible.564 Chapitre 6 Images et clés et courbes
Remarque : pour ajouter une image clé, vous pouvez également positionner le pointeur 
sur le menu Animation et appuyer sur Option. Lorsque l’icône d’image clé apparaît 
en regard du point, cliquez afin d’ajouter une image clé.
Supprimer l’image clé : supprime l’image clé actuelle. L’option Supprimer l’image clé n’est 
accessible que si la tête de lecture est positionnée sur une image sur laquelle une image clé 
existe déjà.
Image clé précédente : place la tête de lecture sur l’image clé précédente de ce paramètre. 
La commande Image clé précédente n’est disponible que si une image clé existe plus tôt 
dans le projet.
Image clé suivante : place la tête de lecture sur l’image clé suivante de ce paramètre. 
La commande Image clé suivante n’est disponible que si une image clé existe plus loin 
dans le projet.
Afficher dans l’Éditeur d’images clés : cette commande ouvre l’Éditeur d’images clés et 
affiche les images clés et les courbes du paramètre sélectionné. Pour plus d’informations 
sur l’utilisation de l’Éditeur d’images clés, consultez la rubrique « Animation dans l’Éditeur d’images clés » plus loin dans ce chapitre.
Pour définir des images clés à l’aide du menu Animation :
1 Activez l’enregistrement (appuyez sur A), puis déplacez la tête de lecture vers l’image 
sur laquelle vous souhaitez définir la première image clé.
2 Modifiez la valeur du paramètre que vous souhaitez animer avec des images clé.
3 Cliquez sur le menu Animation, puis sélectionnez « Ajouter une image clé ».
Une image clé est ajoutée sur l’image actuelle.
4 Pour définir une autre image clé pour le même paramètre, déplacez la tête de lecture 
vers l’emplacement suivant et réglez le paramètre. 
Une image clé est automatiquement ajoutée lorsque vous modifiez le paramètre.
Raccourci d’ajout d’une image clé
Pour ajouter rapidement une image clé sans accéder au menu Animation de 
l’Inspecteur, appuyez sur les touches Contrôle + K. Une image clé est automatiquement 
ajoutée au dernier paramètre modifié de l’objet (quel que soit l’état du bouton 
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Pour se rendre sur une image clé :
1 Cliquez sur le menu Animation correspondant au paramètre de l’image clé 
que vous cherchez.
2 Sélectionnez Image clé précédente si l’image clé souhaitée se trouve avant la position 
actuelle dans le temps, ou sélectionnez Image clé suivante si l’image clé souhaitée 
se trouve après la position actuelle dans le temps.
Remarque : vous pouvez également choisir Marquer > Aller à > Image clé précédente 
(Option + K) ou Image clé suivante (Maj + K) pour passer d’une image clé à l’autre.
Pour supprimer une image clé :
1 Déplacez la tête de lecture vers l’image dont l’image clé est actuellement définie.
2 Cliquez sur le menu Animation pour le paramètre que vous souhaitez modifier, puis 
sélectionnez Supprimer l’image clé.
Remarque : pour supprimer toutes les images clés d’un paramètre, choisissez Réinitialiser 
le paramètre dans le menu Animation.
Pour réinitialiser toutes les images clés d’un paramètre :
m Cliquez sur le menu Animation du paramètre que vous souhaitez réinitialiser, 
puis choisissez Réinitialiser le paramètre. 
Toutes les images clés de ce paramètre sont alors supprimées.
État du menu Animation
Selon qu’un paramètre est animé ou non, ou que la tête de lecture est positionnée 
ou non sur une image clé, le menu Animation affiche une icône différente. Ainsi, 
vous pouvez déterminer l’état de ce paramètre d’un coup d’œil.
Paramètre animé avec des images clés
Le paramètre n’est pas animé
Comportement appliqué au paramètre
Paramètre animé avec des images 
clés incluant une image clé sur 
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Bouton Réinitialiser
Chaque paramètre défini dans l’Inspecteur est équipé d’un bouton Réinitialiser. 
Un paramètre défini peut être un filtre ou une catégorie d’effets ou de transformations, 
telle que Transformer, Fusion ou d’autres options de l’onglet Propriétés.
Le bouton Réinitialiser supprime toutes les images clés appliquées à tous les paramètres 
dans l’ensemble et restaure ces paramètres à leur état par défaut.
Animation dans la Timeline
Lors de l’utilisation d’images clés, il est souvent très utile pour afficher les images clés 
dans le temps. Ainsi, vous pouvez aligner les images clés avec d’autres éléments de 
chronologie importants de votre projet tels que les points de montage, des signaux 
sonores, des marqueurs, et même d’autres images clés. Ces fonctions sont accessibles 
dans la Timeline.
Pour afficher vos images clés dans la Timeline, vous devez tout d’abord activer l’option 
« Afficher/Masquer les images clés ».
Bouton 
Réinitialiser
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Pour afficher les images clés dans la Timeline :
m Cliquez sur le bouton « Afficher/Masquer les images clés ».
Vous pouvez identifier la valeur d’une image clé dans le menu contextuel. Si plusieurs 
images clés se trouvent sur la même image, elle sont répertoriées dans le menu.
Pour afficher la valeur d’une image clé :
m Dans la Timeline, cliquez sur l’image clé tout en maintenant la touche Contrôle enfoncée. 
Un menu contextuel apparaît. Les premiers éléments de la liste sont les valeurs 
de l’image clé pour toutes les images clés de cette image.
Remarque : il est impossible d’ajouter des images clés dans la Timeline.
Modification d’images clés dans la Timeline
Lorsque les images clés sont visibles dans la Timeline, vous pouvez modifier leur position 
dans le temps en les faisant glisser horizontalement sur la piste. La valeur du paramètre 
correspondant à l’image clé n’est alors pas modifiée, seule la position dans le temps 
de l’image clé change. 
Pour déplacer une image clé dans la Timeline :
1 Cliquez sur le bouton Afficher/Masquer les images clés dans la Timeline.
Toutes les images clés dans le projet apparaissent alors.
Bouton « Afficher/Masquer 
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2 Identifiez l’objet sur lequel se trouve l’image clé.
3 Faites glisser l’image clé vers la gauche ou vers la droite pour le déplacer en avant 
ou en arrière dans le temps.
Même si le déplacement d’une image clé dans le temps ne modifie pas la valeur 
du paramètre, il peut avoir un effet significatif sur la nature de l’animation. Par exemple, 
si deux images clés animent un objet du haut vers le bas de l’écran pendant cinq 
secondes, si vous déplacez l’une des images clés, vous ralentissez l’animation (si vous 
les éloignez l’une de l’autre) ou vous l’accélérez (si vous les rapprochez).
Lorsque plusieurs valeurs d’images clés sont définies au niveau d’une seule image, 
vous pouvez choisir de modifier séparément n’importe laquelle de ces valeurs, même 
si elles sont toutes représentées par un seul marqueur d’image clé dans la Timeline.
Pour modifier la valeur d’une image clé présente dans la Timeline :
1 Appuyez simultanément sur la touche Contrôle et cliquez sur l’image clé.
Un menu contextuel apparaît. Les premiers éléments de la liste sont les valeurs 
de l’image clé pour toutes les images clés de cette image.
2 Choisissez la valeur d’image clé que vous souhaitez modifier.
3 Saisissez une nouvelle valeur dans le champ prévu à cet effet, puis appuyez sur Retour.
Remarque : pour quitter un champ de valeur actif sans apporter la moindre modification, 
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Alignement d’images clés avec d’autres objets
L’un des principaux avantages de la manipulation des images clés dans la Timeline est 
la capacité d’aligner une image clé avec une autre.mportant time marker. 
4 Identifiez l’image clé que vous souhaitez déplacer.
Remarque : si vous cliquez sur une image clé tout en maintenant la touche Contrôle 
enfoncée, un menu contextuel apparaît. Il contient le nom du paramètre et la valeur 
de chaque image clé. Si plusieurs images clés se trouvent au même endroit dans 
la chronologie, le menu contextuel les répertorie toutes. 
5 Glissez l’image clé jusqu’à ce qu’elle s’aligne avec le bord de l’objet. 
Si vous appuyez sur la touche Maj tout en faisant glisser l’image clé, celle-ci se magnétise 
sur les bords d’autres objets.
Vous pouvez utiliser cette même technique pour aligner des images clés d’un objet sur 
les images clés d’un autre objet. Ainsi, vous pouvez configurer deux objets pour leur 
appliquer un fondu entrant ou un flou sur exactement la même image. Peu importe 
que ces objets soient situés dans le même groupe ou non. 
Pour aligner les images clés de plusieurs objets :
1 Cliquez sur le bouton « Afficher/Masquer les images clés » dans la Timeline.
Toutes les images clés dans le projet apparaissent alors.
2 Identifiez l’image clé que vous souhaitez déplacer.
3 Trouvez l’objet contenant l’action parallèle.
4 Glissez l’image clé dans le premier objet jusqu’à ce qu’elle s’aligne avec l’image clé 
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Alignement d’images clés sur des marqueurs
D’autres objets de votre Timeline peuvent également servir comme guides pour savoir 
vers où déplacer les images clés. Par exemple, vous pouvez avoir une morceau ou une 
ligne de narration sur lesquels vous souhaitez qu’un effet particulier s’arrête ou change.
L’une des manières les plus intéressantes pour cela est d’avoir recours aux marqueurs. 
Identifiez simplement l’image importante à l’aide d’un marqueur et faites glisser 
l’image clé jusqu’à ce qu’elle s’aligne sur le marqueur. Les marqueurs créent des points 
de magnétisme, ainsi, si vous appuyez sur la touche Maj tout en faisant glisser l’image 
clé, celle-ci s’alignera sur les marqueurs. Pour en savoir plus sur le réglage de marqueurs, 
reportez-vous à la rubrique « Ajout de marqueurs » à la page 398.
Pour aligner une image clé sur un marqueur:
1 Cliquez sur le bouton « Afficher/Masquer les images clés » dans la Timeline.
Toutes les images clés dans le projet apparaissent alors.
2 Identifiez l’image clé que vous souhaitez déplacer et faites-la glisser vers le marqueur.
3 Appuyez sur la touche Maj tout en faisant glisser l’image afin de permettre 
la magnétisation. 
L’image clé s’aligne sur le marqueur.
Suppression d’images clés dans la Timeline
Si vous devez supprimer une image clé ou supprimer toutes les images clés d’un projet 
particulier, vous pouvez supprimer des images clés à l’aide du menu contextuel 
de la Timeline.
Pour supprimer une image clé dans la Chronologie :
1 Cliquez sur le bouton « Afficher/Masquer les images clés » dans la Timeline.
Toutes les images clés dans le projet apparaissent alors.
2 Appuyez simultanément sur la touche Contrôle et cliquez sur l’image clé que vous 
souhaitez supprimer, puis sélectionnez Supprimer l’image clé dans le menu contextuel.
Pour supprimer toutes les images clés d’un objet :
1 Cliquez sur le bouton « Afficher/Masquer les images clés » dans la Timeline.
Toutes les images clés dans le projet apparaissent alors.
2 En maintenant la touche Contrôle enfoncée, cliquez sur une image clé quelconque 
de l’objet que vous souhaitez supprimer, puis sélectionnez « Supprimer toutes les 
images clés » dans le menu contextuel.
Pour un contrôle plus précis des effets utilisés avec des images clés, vous pouvez 
utiliser l’Éditeur d’images clés. Toutes les images clés de la Timeline peuvent être 
affichées dans l’Éditeur d’images clés, à l’aide du menu contextuel.Chapitre 6 Images et clés et courbes 571
Pour afficher une image clé dans l’Éditeur d’images clés :
m En maintenant la touche Contrôle enfoncée, cliquez sur l’image clé dans la Timeline, 
puis choisissez « Afficher dans l’Éditeur d’images clés » dans le menu contextuel. 
L’Éditeur d’images clés passe au premier plan et l’image clé (et le reste de ce paramètre) 
est mise en surbrillance dans le graphique.
Trim sur les effets animés à l’aide d’images clés
Lorsque la durée d’un effet tel qu’un filtre ou un comportement dans la Timeline est 
modifiée, les images clés appliquées à cet objet sont mises à l’échelle en conséquence. 
Cela signifie qu’un effet animé à l’aide d’images clés pour changer avec le temps accé-
lère ou ralentit si l’objet auquel il s’applique est raccourci ou allongé.
Le changement de durée d’un objet ne modifie pas les images clés appliquées aux 
attributs de l’onglet Propriétés ou Objet dans l’Inspecteur. Les images clés apparaissent 
dans la zone en dessous de la barre d’objet si vous choisissez l’option « Afficher/Masquer 
les images clés » dans la Timeline.
Vous pouvez également accélérer ou ralentir un effet animé à l’aide d’images clés 
en redimensionnant la barre de l’effet dans la Timeline.
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Vous pouvez également empêcher ce redimensionnement automatique en appuyant 
sur la touche Commande tout en redimensionnant un objet effet. Cela modifie la durée 
globale de l’effet, mais ne change pas la vitesse à laquelle l’effet change, telle qu’elle 
est définie par les images clés. 
En appuyant sur la touche Commande tout en redimensionnant un objet auquel sont 
appliqués des effets, vous effectuez un Trim sur l’objet sans l’appliquer aux effets. En fait, 
la méthode est la même que lors de l’application d’un Trim à un groupe sans modifier 
les durées de ses composants.
Animation dans l’Éditeur d’images clés
A chaque fois que vous créez deux ou plusieurs images clés, Motion génère des valeurs 
interpolées pour les images intermédiaires. Celles-ci s’appellent des courbes. L’Éditeur 
d’images clés est le contrôle qui vous permet d’afficher et d’apporter des modifications à 
ces courbes. Cette fonction offre l’un des outils les plus sophistiqués et les plus puissants 
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L’affichage des courbes pour vos paramètres animés vous offre un autre moyen 
de comprendre la manière dont votre effet change dans le temps. Les courbes sont 
disposées sur un graphique qui vous permet de comparer les courbes de différents 
paramètres. Lorsque vous maîtriserez mieux la lecture de ces graphiques, vous saurez 
comment et pourquoi certains effets semblent plus naturels ou artificiels. 
Dans l’Éditeur d’images clés, vous pouvez ajouter et supprimer des images clés, ainsi 
que les déplacer dans un espace bidimensionnel pour modifier leurs valeurs (haut-bas) 
et leurs positions dans le temps (gauche-droite). Grâce aux outils fournis dans Motion, 
il vous est également possible de manipuler directement les courbes. De plus, vous pouvez 
définir diverses méthodes d’interpolation, et créer ainsi des types d’effets complètement 
différents. L’Éditeur d’images clés vous permet enfin d’appliquer directement des 
comportements Paramètre à des courbes. Pour ce faire, il vous suffit de cliquer sur 
le nom d’une courbe tout en maintenant la touche Contrôle enfoncée, puis de choisir 
un comportement Paramètre dans le menu contextuel. Pour en savoir plus sur 
les comportements Paramètre, voir « Comportements Paramètre » à la page 471.574 Chapitre 6 Images et clés et courbes
Par exemple, lorsque des objets bougent dans le monde réel, ils respectent les règles 
de la physique, telles que l’inertie ou le moment. L’Éditeur d’images clés de Motion 
vous permet de simuler ces types d’effets dans vos animations.
Pour afficher l’Éditeur d’images clés, procédez comme suit :
m Si la fenêtre du contrôle du temps est déjà affichée, cliquez sur l’onglet Éditeur d’images 
clés dans celui-ci.
m Choisissez Fenêtre > Éditeur d’images clés.
m Appuyez simultanément sur les touches Commande + 8.
Vérification de votre sélection
Les paramètres disponibles dans l’Éditeur d’images clés dépendent des objets 
sélectionnés dans les autres fenêtres. Si vous sélectionnez un élément dans les fenêtres 
Couches, Canevas ou Timeline, seuls les paramètres de cet objet sont accessibles à 
partir de l’Éditeur d’images clés.
Si vous souhaitez comparer des courbes à partir de paramètres de plusieurs objets 
(par exemple, démarrer le fondu entrant au même moment pour deux objets), vous 
devez sélectionner les deux éléments sous l’onglet Couche ou dans une autre fenêtre. 
Ainsi, les paramètres des deux objets figurent dans l’Éditeur d’images clés.
Par ailleurs, vous pouvez modifier les courbes d’un groupe si vous sélectionnez ce 
groupe au lieu des objets qu’il contient. De cette manière, vous avez la possibilité 
d’afficher ou de modifier l’activité des images clés susceptibles d’affecter tous 
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Parties de l’Éditeur d’images clés
L’Éditeur d’images clés se compose d’une liste de paramètres à gauche et d’un graphique 
multifonctionnel à droite. 
Champ d’image actuelle
Ce champ vous permet d’accéder instantanément à n’importe quelle image de votre 
projet. Comme il s’agit également d’un curseur de valeur, vous pouvez le faire glisser 
pour déplacer la tête de lecture vers une nouvelle image.
Pour accéder à une image, procédez comme suit :
m Cliquez deux fois sur le champ valeur, saisissez un numéro d’image, puis appuyez 
sur Retour. 
La tête de lecture se déplace vers l’image spécifiée. 
m Faites glisser le curseur de valeur « Sur l’image actuelle » vers la gauche ou vers la 
droite. Si vous le faites glisser vers la gauche, la tête de lecture se déplace vers un point 
antérieur dans le temps. Si vous le faites glisser vers la droite, elle avance dans le temps.
Outils relatifs aux images clés
L’Éditeur d’images clés met à votre disposition trois outils pour vous aider à modifier 
des images clés et des courbes. Pour en savoir plus sur l’utilisation de ces outils, 
voir « Modification d’images clés » à la page 586.
Édition : sélectionne et modifie des images clés.
Esquisse : dessine des courbes avec des images clés.
Liste des paramètres
Commandes de zoom
Menu Animation
Zone courbe
Menu Afficher
Boutons de commande
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Cadre : fait glisser une zone de sélection pour entourer et manipuler les images clés.
Liste des paramètres
La liste située à gauche de l’onglet Éditeur d’images clés peut afficher tous les paramètres 
de vos éléments sélectionnés, dès lors qu’il est possible de les animer avec des images 
clés. Elle inclut les propriétés d’objet, les filtres et les comportements. En sélectionnant 
plusieurs éléments sous l’onglet Couches ou dans la Timeline, vous pouvez comparer 
les paramètres de plusieurs objets. 
Case d’activation : la case sur la gauche détermine quels paramètres sont affichés 
dans le graphique. Les paramètres cochés sont considérés comme « activés ».
Colonne de nom du paramètre : la deuxième colonne répertorie le nom de l’objet 
et les noms des paramètres pour chaque objet.
Colonne de valeur : la troisième colonne affiche la valeur du paramètre pour l’image 
où la tête de lecture est actuellement positionnée. Si la tête de lecture est figée sur 
une image clé, le champ affiche la valeur de cette image clé. Si la tête de lecture n’est pas 
figée sur une image clé, le champ affiche la valeur de ce paramètre de cette image. Pour 
plus d’informations sur la modification des valeurs des images clés, consultez la rubrique 
« Modification d’images clés » à la page 586.
Vous pouvez cliquer sur la valeur afin d’activer le champ. Lorsque l’enregistrement est 
activé, une image clé est automatiquement ajoutée si vous cliquez sur le champ 
de valeur d’une image qui ne comporte pas d’image clé. Pour taper une valeur dans 
le champ, double-cliquez dessus.
Remarque : la sélection d’une image clé n’affiche pas la valeur de cette image clé, mais 
la valeur d’un paramètre de l’image où se trouve la tête de lecture.
Menu Animation : la quatrième colonne contient un menu contextuel qui imite le menu 
Animation de l’Inspecteur. Toutefois, le menu Animation de l’Éditeur d’images clés 
contient plusieurs commandes qui n’existent pas dans l’Inspecteur.
Outil Édition
(par défaut)
Outil Esquisse
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Â Activer/Désactiver l’animation : cette commande reste inaccessible jusqu’à ce qu’une 
image clé soit appliquée au paramètre, soit en utilisant le bouton Enregistrer, soit 
en ajoutant directement une image clé. Une fois qu’une animation est appliquée 
au paramètre, la commande est automatiquement renommée Désactiver l’animation. 
Si vous l’activez à ce stade, vous masquez en fait les images clés que vous avez définies 
et vous restaurez le paramètre à sa valeur par défaut. Toutefois, les images clés ne sont 
pas supprimées. Si vous sélectionnez Activer l’animation, le paramètre est restauré à son 
état le plus récent lié aux images clés.
Â Réinitialiser le paramètre : supprime toutes les images clés et les réglages pour 
ce paramètre. La valeur du paramètre est réinitialisée sur sa valeur par défaut.
Â Ajouter une image clé : ajoute une image clé sur l’image actuelle dans la mini-Timeline. 
Si la tête de lecture est positionnée sur une image sur laquelle une image clé a déjà été 
ajoutée, cette commande du menu est inaccessible.
Remarque : comme indiqué dans la section relative au menu Animation, vous pouvez 
utiliser un raccourci clavier pour ajouter rapidement une image clé en appuyant sur 
Contrôle + K. Une image clé est automatiquement ajoutée au dernier paramètre 
modifié de l’objet.
Â Supprimer l’image clé : supprime l’image clé actuelle. La commande Supprimer l’image 
clé n’est disponible que si la tête de lecture est placée sur une image contenant déjà 
une image clé.
Â Image clé précédente : place la tête de lecture sur l’image clé précédente de ce 
paramètre. La commande Image clé précédente n’est disponible que si une image 
clé existe plus tôt dans le projet.
Â Image clé suivante : place la tête de lecture sur l’image clé suivante de ce paramètre. 
La commande Image clé suivante n’est disponible que si une image clé existe plus loin 
dans le projet.
Â Interpolation : définit le type de courbe du paramètre. Pour obtenir des exemples 
des différentes méthodes d’interpolation, reportez-vous au tableau de la rubrique 
« Modification des courbes » plus loin dans ce chapitre. Vous avez le choix entre 
Constante, Linéaire, Bézier, En continu, Atténuation en entrée, Atténuation en sortie, 
Exponentielle ou Logarithmique.
Â Avant la première image clé : définit ce qui arrive entre la première image clé et le 
début du plan. Pour obtenir des exemples des différentes méthodes d’extrapolation, 
reportez-vous au tableau de la rubrique « Extrapolation » plus loin dans ce chapitre. 
Sélectionnez Constante, Linéaire, Ping-Pong, Répétition ou Progressif. Vous pouvez 
également convertir une extrapolation en images clés réelles en sélectionnant 
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Â Après la dernière image clé : définit ce qui arrive entre la dernière image clé et la 
fin du plan. Pour obtenir des exemples des différentes méthodes d’extrapolation, 
reportez-vous au tableau de la rubrique « Extrapolation » plus loin dans ce chapitre. 
Sélectionnez Constante, Linéaire, Ping-Pong, Répétition ou Progressif. Vous pouvez 
également convertir une extrapolation en images clés réelles en sélectionnant 
Générer des images clés.
Â Verrouiller/Déverrouiller le paramètre : verrouille ce paramètre contre toute autre 
modification. Lorsqu’un paramètre est verrouillé, ni les images clés, ni les courbes 
ne peuvent être ajustées.
Â Réduire les images clés : applique un algorithme de dilution aux images clés du 
paramètre sélectionné, ce qui réduit le nombre d’images clés dans un paramètre 
tout en essayant de conserver une forme similaire pour la courbe. L’algorithme de 
dilution se règle de deux façons : l’augmentation de la tolérance maximale d’erreurs 
permet d’obtenir quelques images clés et l’augmentation du facteur de lissage rend 
les courbes plus lisses entre les valeurs d’images clés.
Â Définir sur instantané de courbe : si la case « Prendre/Afficher instantané 
de courbe » est cochée (dans le coin inférieur gauche de l’Éditeur d’images clés), 
cette option inverse toutes les modifications apportées aux images clés de la courbe 
actuellement sélectionnée et revient à l’instantané le plus récent. Pour en savoir plus, 
consultez la rubrique « Instantanés de courbes » à la page 586.
Commandes de filtrage
L’utilisation efficace de l’Éditeur d’images clés implique le contrôle de la liste des 
paramètres actuellement affichés dans la présentation graphique. Même si vous 
souhaitez accéder rapidement à tous les paramètres que vous animez, l’affichage 
de trop nombreux paramètres à la fois rend la lecture du graphique difficile. Motion 
vous permet de stocker des ensembles de paramètres pour faciliter cette gestion.Chapitre 6 Images et clés et courbes 579
Menu local Afficher
Le menu local Afficher vous permet d’afficher dix ensembles de courbes de paramètres 
intégrés ou personnalisés. 
Pour afficher tous les paramètres de tous les éléments sélectionnés :
m Choisissez Tout dans le menu local Afficher.
Par défaut, seuls les paramètres animés sont actifs dans le graphique. Activez ou 
désactivez des paramètres individuels en cliquant sur la case pour les afficher 
ou les masquer dans le graphique. Vous pouvez choisir d’afficher tous les paramètres 
associés à un groupe ou à un objet particulier en cochant ou en désactivant la case 
correspondant à ce groupe ou à cet objet.
Sinon, vous pouvez choisir de n’afficher que les paramètres qui sont actuellement animés, autrement dit, les paramètres qui contiennent déjà une ou plusieurs images clés.
Pour afficher uniquement les paramètres animés (avec des images clés ou 
des comportements), procédez de l’une des manières suivantes :
m Choisissez Animé dans le menu local Afficher.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche U.
Tous les paramètres comportant une ou plusieurs images clés sont alors affichés.
Pour afficher les paramètres modifiés et qui ne correspondent plus à leur valeur 
par défaut, procédez de l’une des manières suivantes :
m Sélectionnez Modifié dans le menu local de la liste d’ensemble de courbes.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche Y.580 Chapitre 6 Images et clés et courbes
Cette option affiche uniquement les paramètres dont le réglage ne correspond plus à 
la valeur par défaut ou qui sont en cours de modification (dans le Canevas, l’Inspecteur 
ou la palette).
Pour afficher uniquement les paramètres actuellement activés :
m Choisissez Activé dans le menu local Afficher.
Lorsque cette option est sélectionnée et que vous déplacez un objet dans le Canevas, 
les paramètres Position X et Y sont affichés ainsi que les courbes.
Ensembles de courbes connexes
Motion est livré avec quelques ensembles de courbes intégrés qui permettent d’accéder 
rapidement à certains paramètres. Si vous avez besoin de vérifier la position de plusieurs 
objets connexes dans un projet, vous vous faciliterez la tâche en utilisant l’ensemble 
de courbes Position. Il est d’ailleurs possible d’afficher plusieurs ensembles de courbes 
connexes en même temps, afin de vous éviter le désagrément d’avoir à passer constamment de l’un à l’autre. Chacun de ces ensembles de courbes intégrés est associé à 
un raccourci clavier.
Pour afficher uniquement les paramètres Position d’un objet sélectionné, 
procédez de l’une des manières suivantes :
m Choisissez Position dans le menu local Afficher.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche P.
Les paramètres Position de l’objet sélectionné apparaissent.
Pour afficher uniquement les paramètres Rotation d’un objet sélectionné, 
procédez de l’une des manières suivantes :
m Choisissez Rotation dans le menu local Afficher.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche R.
Les paramètres Rotation de l’objet sélectionné apparaissent.
Pour afficher uniquement les paramètres Échelle d’un objet sélectionné, 
procédez de l’une des manières suivantes :
m Choisissez Échelle dans le menu local Afficher.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche S.
Les paramètres Échelle de l’objet sélectionné apparaissent.
Pour afficher uniquement les paramètres Déformation d’un objet sélectionné, 
procédez de l’une des manières suivantes :
m Choisissez Déformation dans le menu local Afficher.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche H.
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Pour afficher uniquement les paramètres Point d’ancrage d’un objet sélectionné, 
procédez de l’une des manières suivantes :
m Choisissez Point d’ancrage dans le menu local Afficher.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche A.
Les paramètres Point d’ancrage de l’objet sélectionné apparaissent.
Pour afficher uniquement le paramètre Opacité d’un objet sélectionné, 
procédez de l’une des manières suivantes :
m Choisissez Opacité dans le menu local Afficher.
m Alors que l’Éditeur d’images clés est activé, appuyez sur la touche O.
Le paramètre Opacité de l’objet sélectionné apparaît.
Ensembles de paramètres personnalisés
En plus d’utiliser des ensembles de courbes intégrés, vous pouvez créer vos propres 
ensembles. Au fur et à mesure que vous créez des ensembles de paramètres personnalisés, ceux-ci apparaissent dans le menu local Afficher, ce qui vous permet de passer de 
l’un à l’autre rapidement. La suppression, la duplication et la modification d’ensembles 
personnalisés s’effectuent dans la zone de dialogue Gérer les ensembles de courbes. 
Pour créer un nouvel ensemble de paramètres :
1 Sélectionnez Nouvel ensemble de courbes dans le menu local Afficher. 
Une zone de dialogue s’ouvre.
2 Saisissez un nom pour l’ensemble, puis cliquez sur OK.
Une fois votre ensemble créé, vous pouvez le sélectionner dans le menu local Afficher.582 Chapitre 6 Images et clés et courbes
Pour ajouter des paramètres à un ensemble de paramètres personnalisés, 
effectuez l’une des opérations suivantes :
m Faites glisser le paramètre à partir d’un onglet quelconque de l’Inspecteur vers l’Éditeur 
d’images clés.
m Cliquez sur le menu Animation de ce paramètre, puis sélectionnez Afficher dans l’Éditeur 
d’images clés.
Le paramètre est ajouté à l’ensemble de courbes personnalisé.
Remarque : si Animé est choisi dans le menu local Afficher lorsque vous utilisez 
la commande Afficher dans l’éditeur d’images clés dans le menu Animation, 
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m Alors que l’Éditeur d’images clés est activé, maintenez enfoncée la touche Maj et utilisez 
le raccourci clavier associé à l’ensemble de courbes intégré correspondant.
Remarque : si vous appuyez plusieurs fois de suite sur le même raccourci clavier 
d’ensemble de courbes, vous créez un nouvel ensemble de courbes personnalisé 
à chaque fois, avec un nom différent.
Pour supprimer des paramètres d’un ensemble personnalisé :
m Faites glisser le paramètre hors de la liste. Il disparaît en émettant un son « pouf ».
Pour supprimer tous les paramètres d’un ensemble personnalisé :
m Cliquez sur le bouton Effacer la liste des courbes.
Pour supprimer un ensemble de paramètres personnalisés :
1 Sélectionnez « Gérer les ensembles de courbes » dans le menu local Afficher. 
La zone de dialogue « Gérer les ensembles de courbes » apparaît.
2 Sélectionnez le nom de l’ensemble que vous souhaitez supprimer.
3 Cliquez sur le bouton Supprimer (–) en haut de la zone de dialogue. 
L’ensemble est alors supprimé.
4 Cliquez sur Terminé pour fermer la zone de dialogue.
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Pour dupliquer un ensemble de paramètres personnalisés :
1 Sélectionnez « Gérer les ensembles de courbes » dans le menu local Afficher. 
La zone de dialogue « Gérer les ensembles de courbes » apparaît.
2 Sélectionnez le nom de l’ensemble que vous souhaitez dupliquer.
3 Cliquez sur le bouton Dupliquer en haut de la zone de dialogue. 
L’ensemble est alors dupliqué.
4 Cliquez deux fois sur le nom de l’ensemble dans la liste, puis tapez un nouveau nom 
pour l’ensemble.
5 Cliquez sur Terminé pour fermer la zone de dialogue.
Le nouvel ensemble apparaît désormais dans le menu local Afficher. Ces ensembles sont 
enregistrés avec le projet afin que chaque fois que vous rouvrez le projet, ils soient accessibles. Stockez autant d’ensembles de paramètres que vous le souhaitez. Une fois un ensemble de paramètres sauvegardé, vous pouvez le modifier ou le supprimer, si nécessaire.
Graphique des courbes
Un graphique apparaît à droite de la liste des paramètres et affiche les courbes associées au paramètre que vous avez sélectionné. Ce graphique comporte une règle de 
temps en haut et une commande de zoom/défilement en bas qui sont identiques aux 
commandes correspondantes de la Timeline. Ceux-ci vous permettent d’identifier à 
quel moment les images clés apparaissent, ainsi que d’afficher des marqueurs de projet, de lire des Points d’entrée et de sortie et la tête de lecture. Grâce aux contrôles de 
zoom en bas du graphique, vous pouvez effectuer un zoom avant afin d’obtenir un 
contrôle plus précis du positionnement de l’image clé et de la courbe actuelle. Pour en 
savoir plus sur l’utilisation des commandes de zoom/défilement, consultez la rubrique 
« Zoom avant sur la Timeline » à la page 102.
Le corps du graphique affiche les images clés et les courbes des paramètres actifs. 
Chaque paramètre est d’une couleur différente, pourtant certaines couleurs 
sont dupliquées. 
Enregistrement des courbes d’animation
Vous avez la possibilité d’enregistrer des courbes d’animation dans un dossier existant de 
la Bibliothèque, comme la catégorie Favoris, ou de créer un nouveau dossier au sein d’une 
catégorie existante. Dès que vous avez placé une courbe d’animation dans la Bibliothèque, 
elle peut être ajoutée à un objet de n’importe lequel de vos projets. Les courbes d’animation enregistrées dans la Bibliothèque apparaissent avec une icône personnalisée.
Remarque : dans le Finder, les éléments enregistrés dans la Bibliothèque portent 
l’extension .molo (pour « Motion Library object »). Il est impossible de les ouvrir 
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Vous pouvez enregistrer de multiples courbes dans la Bibliothèque sous la forme d’un seul 
ou de plusieurs fichiers. Par exemple, si vous créez une animation à partir de plusieurs 
courbes et que vous souhaitez sauvegarder l’effet cumulé obtenu, vous pouvez enregistrer 
toutes les courbes sous la forme d’un seul élément dans la Bibliothèque.
Même si vous avez la possibilité d’enregistrer vos courbes d’animation dans la catégorie 
Contenu, il est plutôt recommandé de sauvegarder tous les éléments que vous utilisez 
fréquemment dans la catégorie Favoris. Certaines catégories de la Bibliothèque de Motion 
contiennent tellement d’éléments que les catégories Favoris et Menu Favoris peuvent 
vous faire gagner du temps lors de vos recherches. Vous pouvez d’ailleurs créer d’autres 
dossiers au sein de la catégorie Favoris afin d’organiser au mieux vos éléments 
personnalisés. 
Vous pouvez également créer de nouveaux dossiers dans des catégories existantes, 
comme Favoris, Menu Favoris ou Contenu. Les dossiers créés dans la catégorie Contenu 
apparaissent dans la barre latérale de la Bibliothèque. En revanche, les dossiers créés 
dans des sous-catégories, comme Animation standard, sont affichés dans la pile de 
la Bibliothèque, mais pas dans sa barre latérale. Pour en savoir plus sur la création de 
dossiers dans la Bibliothèque, voir « Enregistrement et partage de comportements 
personnalisés » à la page 442.
Les courbes d’animation enregistrées dans la catégorie Menu Favoris s’appliquent très 
rapidement à des objets grâce au menu Favoris.
Pour enregistrer une courbe d’animation dans la Bibliothèque :
1 Ouvrez la Bibliothèque, puis sélectionnez la catégorie Contenu, Favoris ou Menu Favoris.
2 Faites glisser le nom de la courbe d’animation de paramètre que vous souhaitez 
enregistrer de la liste des paramètres affichée par l’Éditeur d’images clés vers la pile 
au bas de la Bibliothèque.
Lorsque vous enregistrez une courbe d’animation, elle est placée dans le dossier 
/Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/Final Cut Studio/
Motion/Bibliothèque.
Remarque : si vous faites glisser une courbe d’animation vers une autre sous-catégorie, 
comme Éclat (dans la catégorie Filtres), elle est automatiquement placée dans la catégorie 
Contenu, qui est alors activée.
Pour enregistrer plusieurs courbes d’animation dans la Bibliothèque :
1 Ouvrez la Bibliothèque, puis sélectionnez la catégorie Contenu, Favoris ou Menu Favoris.
2 Dans la liste des paramètres affichée par l’Éditeur d’images clés, sélectionnez toutes les 
courbes d’animation que vous souhaitez enregistrer, puis faites-les glisser vers la pile 
tout en maintenant le bouton de la souris enfoncé.586 Chapitre 6 Images et clés et courbes
3 Lorsque le menu déroulant apparaît, choisissez « Tous dans un fichier » ou 
Fichiers multiples.
L’option « Tous dans un fichier » enregistre toutes les courbes d’animation ensemble et 
elles sont ensuite répertoriées comme un seul élément dans la Bibliothèque. À l’inverse, 
l’option Fichiers multiples enregistre les courbes dans la Bibliothèque comme des élé-
ments individuels.
4 Pour attribuer un nom au(x) fichier(s), procédez de l’une des manières suivantes :
Â Cliquez sur son icône tout en maintenant la touche Contrôle enfoncée, choisissez 
Renommer dans le menu contextuel, puis saisissez un nom descriptif.
Â Sélectionnez l’icône, cliquez sur son nom, puis saisissez un nom descriptif.
Remarque : lorsque vous cliquez sur l’icône d’une courbe d’animation dans la pile de 
la Bibliothèque tout en maintenant la touche Contrôle enfoncée, l’option Modifier 
la description est proposée dans le menu contextuel. Il s’agit d’un outil très pratique 
qui vous permet de rédiger des notes personnelles sur un élément enregistré dans 
la Bibliothèque. Après avoir choisi Modifier la description, entrez vos notes dans 
le champ de texte, puis cliquez sur OK.
Modification d’images clés
L’Éditeur d’images clés offre un environnement idéal pour la manipulation de vos images 
clés, car il vous permet d’afficher leurs valeurs, leur position dans le temps et la manière 
dont les modifications ont une incidence sur les courbes d’interpolation qui entourent 
vos images clés.
Instantanés de courbes
Il s’avère souvent utile de disposer d’une image de référence pour vos courbes lorsque 
vous modifiez des images clés. En effet, cette image de référence sert aussi bien de guide 
lors de vos modifications, que de filet de sécurité si vous apportez des modifications 
que vous souhaitez par la suite annuler pour rétablir la courbe d’origine.
Pour prendre et afficher des instantanés de courbes :
m Cliquez sur le bouton « Prendre/Afficher instantané de courbe » situé en bas de l’Éditeur 
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Dès lors, si vous déplacez des images clés dans l’Éditeur d’images clés, la courbe d’origine apparaît dans une couleur plus claire (telle qu’elle était au moment où vous avez 
pris l’instantané). Cet instantané de courbe reste disponible aussi longtemps que vous 
modifiez l’ensemble actuel de courbes l’Éditeur d’images clés.
Après avoir modifié une courbe, si vous préférez revenir à l’instantané, il vous suffit 
d’utiliser le menu Animation de l’Éditeur d’images clés.
Pour rétablir l’instantané le plus récent d’une courbe :
m Dans le menu Animation de l’Éditeur d’images clés, choisissez « Définir sur instantané 
de courbe ».
La courbe est alors rétablie telle qu’elle se présentait dans le dernier instantané.
Important : si vous chargez un autre ensemble de courbes dans l’Éditeur d’images clés 
ou décidez de le fermer, des instantanés de courbes sont repris, remplaçant les précédents.
Utilisation de l’outil Édition
Pour être en mesure de suivre les instructions suivantes, vous devez tout d’abord sélectionner l’outil Édition parmi les outils disponibles dans l’Éditeur d’images clés.
Pour changer la valeur d’une image clé, procédez de l’une des manières suivantes : 
m Cliquez sur l’image clé que vous souhaitez modifier, puis faites-la glisser le long de l’axe 
Y (vers le haut ou vers le bas) afin de modifier sa valeur. Pour modifier sa position 
dans le temps, faites-la glisser le long de l’axe X (vers la gauche ou vers la droite).
Appuyez sur la touche Maj tout en faisant glisser la souris afin de contraindre 
le mouvement sur un axe.
Courbe d’origine (en rose)
Nouvelle 
courbe 
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Lorsque vous faites glisser une image clé dans le graphique, des nombres apparaissent 
pour indiquer sa nouvelle position et sa valeur. Le premier de ces nombres correspond 
au numéro d’image et le second, à la valeur du paramètre.
Si vous rapprochez deux images clés sur l’axe X, la transformation entre ces deux 
valeurs est effectuée plus rapidement. Au contraire, si vous éloignez les images clés 
l’une de l’autre, la modification se produit plus doucement.
m Double-cliquez sur l’image clé que vous souhaitez modifier, tapez la nouvelle valeur 
dans le champ de valeur, puis appuyez sur Retour.
La valeur de l’image clé est ainsi changée le long de l’axe Y (verticalement).
Remarque : pour sortir d’un champ de valeur actif sans apporter aucune modification, 
appuyez sur Échap.
m Faites glisser le curseur de valeur dans la liste des paramètres.
Numéro d’image Valeur
Valeur de l’image clé
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Â Faites glisser vers la droite afin d’augmenter la valeur de l’image clé le long de l’axe Y.
Â Faites glisser vers la gauche afin de réduire la valeur de l’image clé le long de l’axe Y.
Â Appuyez sur Maj tout en faisant glisser afin de changer la valeur par incréments de 10.
Â Appuyez sur Option tout en faisant glisser afin de changer la valeur par incréments 
de 0,01.
Outre la modification d’images clés existantes, vous pouvez en ajouter ou en supprimer 
directement dans le graphique.
Pour ajouter une image clé :
1 Appuyez sur la touche Option, puis déplacez le pointeur sur la courbe du paramètre 
que vous souhaitez modifier. 
Le pointeur devient un signe plus (+). 
2 Cliquez sur la courbe au niveau de l’image sur laquelle vous souhaitez qu’apparaisse 
l’image clé.
3 Faites glisser l’image clé vers la valeur préférée.
Remarque : vous pouvez également ajouter une image clé à la position actuelle 
de la tête de lecture en choisissant Ajouter une image clé dans le menu Animation 
pour n’importe quel paramètre, ou en double-cliquant sur la courbe.
Les courbes créées lors de l’ajout de nouvelles images clés sont définies sur la méthode 
d’interpolation de Bézier. Pour en savoir plus sur les méthodes d’interpolation, consultez 
la rubrique « Modification des courbes » à la page 595.
Pour supprimer une image clé, procédez de l’une des manières suivantes :
m Sélectionnez l’image clé, puis cliquez sur Supprimer.
Remarque : vous pouvez faire glisser afin de sélectionner plusieurs images clés.
m Appuyez simultanément sur la touche Contrôle et cliquez sur l’image clé, puis sélectionnez 
Supprimer dans le menu contextuel.
m Accédez à l’image clé, puis sélectionnez Supprimer l’image clé dans le menu Animation 
pour ce paramètre.
Pour supprimer toutes les images clés d’un paramètre :
m Cliquez sur le menu Animation dans la liste des paramètres, puis choisissez Réinitialiser 
le paramètre.
Remarque : vous pouvez également utiliser le menu Animation dans l’Inspecteur.590 Chapitre 6 Images et clés et courbes
Contrôle des images clés
En plus de les supprimer, vous pouvez également verrouiller ou désactiver des images 
clés. Par ailleurs, le menu local des images clés comporte des réglages spéciaux que 
vous pouvez appliquer pour contrôler la forme de votre courbe. Pour en savoir plus, 
consultez la rubrique « Modification des courbes » à la page 595.
Pour verrouiller ou désactiver une image clé :
m Appuyez simultanément sur la touche Contrôle et cliquez sur l’image clé que vous souhaitez modifier, puis sélectionnez Verrouiller ou Désactiver dans le menu contextuel.
Verrouiller : empêche toute autre modification de cette image clé.
Désactiver : permet d’ignorer une image clé temporairement sans la supprimer.
Copie et collage d’images clés et de courbes d’animation
Les commandes Copier et Coller vous permettent de déplacer des images clés et 
les courbes d’animation qu’elles forment d’un paramètre à l’autre. Cette technique 
peut être utile pour copier un effet spécifique d’une image clé d’un objet à l’autre, 
pour avancer ou retarder la trajectoire d’une image clé sur le même paramètre, voire 
pour créer des images clés sur un paramètre et les appliquer à un autre paramètre.
Pour copier des images clés, vous devez les sélectionner soit individuellement, soit par 
canal ou canaux entiers.Chapitre 6 Images et clés et courbes 591
Pour sélectionner des images clés, procédez de l’une des manières suivantes :
m Grâce à l’outil Édition, faites glisser une zone de sélection autour des images clés que 
vous souhaitez sélectionner.
m Maintenez la touche Maj et cliquez sur les images clés que vous souhaitez sélectionner.
Une fois les images clés sélectionnées, vous pouvez les couper ou les copier dans 
le Presse-papiers.
Pour copier les images clés sélectionnées :
m Choisissez Édition > Copier (ou appuyez simultanément sur les touches Commande + C).
Pour couper les images clés sélectionnées :
m Choisissez Édition > Couper (ou appuyez simultanément sur les touches Commande + X).
Pour coller vos images clés sélectionnées, vous devez sélectionner à la fois le paramètre 
dans lequel vous souhaitez les coller et le point du temps où vous souhaitez que 
les images clés collées commencent.
Si seule la courbe (et non les images clés) apparaît 
en blanc, les images clés ne sont pas sélectionnées.
Les images clés sélectionnées apparaissent en blanc.592 Chapitre 6 Images et clés et courbes
Pour coller des images clés :
1 Sélectionnez le paramètre de destination dans la liste des paramètres (à gauche de 
l’Éditeur d’images clés).
2 Positionnez la tête de lecture sur le point de la chronologie où vous souhaitez que 
les images clés commencent.
3 Choisissez Édition > Coller (ou appuyez simultanément sur les touches Commande + V).
Remarque : les images clés collées ne génèrent pas forcément la même courbe que 
l’original si l’échelle des paramètres est différente.
Pour sélectionner l’intégralité d’une courbe d’animation, procédez de l’une 
des manières suivantes :
m Sélectionnez la ligne d’un paramètre dans la liste des paramètres affichée par l’Éditeur 
d’images clés.
m Sélectionnez plusieurs paramètres dans la liste des paramètres en cliquant dessus 
tout en maintenant la touche Contrôle ou Maj enfoncée.
Dès que vous avez sélectionné des paramètres animés avec des images clés, 
vous pouvez les couper ou les copier pour les placer dans le Presse-papiers.
Pour copier les courbes d’animation sélectionnées :
m Choisissez Édition > Copier (ou appuyez simultanément sur les touches Commande + C).
Pour couper les courbes d’animation sélectionnées :
m Choisissez Édition > Couper (ou appuyez simultanément sur les touches Commande + X).
Lorsque vous collez des courbes d’animation, toutes les images clés des paramètres de 
destination sont remplacées et le contrôle du temps des images clés d’origine est conservé dans l’ensemble du canal à sa nouvelle destination.
Pour coller des courbes d’animation :
1 Dans la liste des paramètres de l’Éditeur d’images clés, sélectionnez le paramètre 
de destination.
2 Choisissez Édition > Coller (ou appuyez simultanément sur les touches Commande + V).
Remarque : les courbes d’animation collées ne génèrent pas forcément la même 
courbe que l’original si l’échelle des paramètres est différente.
Utilisation de l’outil Esquisse
Situé à côté de l’outil Édition, l’outil Esquisse vous permet de tracer des courbes d’animation dans l’Éditeur d’images clés, tout en créant des images clés au fur et à mesure. 
Afin de pouvoir esquisser une courbe, la liste des paramètres doit tout d’abord afficher 
le paramètre à animer. Pour en savoir plus sur les méthodes à utiliser pour afficher 
certaines courbes, voir « Ensembles de paramètres personnalisés » à la page 581.Chapitre 6 Images et clés et courbes 593
Pour esquisser une courbe d’animation :
1 Dans la liste des paramètres, sélectionnez le paramètre que vous souhaitez esquisser.
2 Choisissez l’outil Esquisse parmi les outils disponibles dans l’Éditeur d’images clés.
3 Faites glisser le pointeur dans le graphique d’images clés pour esquisser une courbe 
d’animation.
Si vous glissez ou cliquez n’importe où dans l’Éditeur d’images clés, les images clés 
existantes sont remplacées.
Pour ajouter des images clés individuelles à l’aide de l’outil Esquisse :
1 Choisissez l’outil Esquisse parmi les outils disponibles dans l’Éditeur d’images clés.
2 Dans la liste des paramètres, sélectionnez le paramètre que vous souhaitez esquisser.
3 Cliquez dans le graphique pour ajouter une image clé.
Chaque nouveau clic crée une image clé supplémentaire.
Utilisation de l’outil Cadre
Également disponible parmi les outils de l’Éditeur d’images clés, l’outil Cadre vous permet 
de tracer un cadre de sélection autour d’un certain nombre d’images clés, puis de 
manipuler leur position en ajustant les poignées du cadre de sélection.
Pour dessiner un cadre de sélection à l’aide de l’outil Cadre :
1 Choisissez l’outil Cadre parmi les outils disponibles dans l’Éditeur d’images clés.
2 Dans le graphique d’images clés, faites glisser le pointeur pour dessiner un cadre de 
sélection autour des images clés que vous souhaitez manipuler.
Paramètre et outil
Esquisse sélectionnés
Faites glisser le pointeur
dans le graphique afin de
créer des images clés pour
le paramètre sélectionné.
Courbe liée aux nouvelles images clés créées
ajoutée à la courbe d’animation existante.594 Chapitre 6 Images et clés et courbes
Un cadre de sélection doté de huit poignées apparaît dans le graphique d’images clés.
Une fois le cadre de sélection dessiné, vous disposez de nombreuses possibilités pour 
manipuler aussi bien le cadre que les images clés qu’il contient. Il vous suffit en fait de 
faire glisser l’une des poignées du cadre de sélection pour la déplacer.
Pour déplacer le cadre de sélection :
m Faites glisser le curseur à l’intérieur du cadre de sélection pour déplacer le cadre 
et les images clés qu’il contient.
Si vous glissez vers la droite ou la gauche, vous modifiez la position dans le temps 
des images clés. En revanche, si vous glissez vers le haut ou le bas, vous augmentez 
ou diminuez la valeur des paramètres des images clés sélectionnées.
Remarque : peu importe où vous faites glisser le cadre, seules les images clés sélectionnées dans le cadre d’origine sont manipulées, même si le cadre repositionné chevauche des images clés qui étaient précédemment en dehors de la zone de sélection. Pour 
manipuler d’autres images clés, vous devez redessiner le cadre de sélection dans le graphique d’images clés.
Paramètres animés avec 
des images clés avant 
la sélection
Poignée du cadre de sélection
Images clés sélectionnées
Transformation d’images clés
Pour repositionner les poignées du cadre de sélection, procédez comme à l’accoutumée 
lorsque vous faites glisser les poignées d’un cadre de sélection autour d’un objet. 
Dans ce cas, la seule différence est que le déplacement d’une des poignées affecte 
non seulement le cadre, mais aussi les images clés qu’il contient. Si vous déplacez 
le cadre, vous déplacez donc toutes les images clés sélectionnées dans la même 
direction. Il vous est ainsi possible de modifier la position de ces images dans le temps 
ou la valeur des paramètres, voire les deux en même temps. Si vous modifiez l’échelle 
du cadre, vous modifiez également les « échelles » des images clés qu’il contient, 
changeant par la même occasion leur contrôle du temps et la valeur des paramètres.
Faites vos propres essais avec le cadre de sélection, afin de mieux comprendre comment vos différentes manipulations affectent les images clés que ce cadre entoure.Chapitre 6 Images et clés et courbes 595
Pour modifier l’échelle du cadre de sélection :
m Maintenez la touche Option enfoncée et faites glisser l’une des poignées du cadre 
de sélection.
La taille du cadre augmente ou diminue en fonction du déplacement du curseur 
le long des axes.
Pour déformer le cadre de sélection de façon non proportionnelle :
m Maintenez la touche Commande enfoncée et faites glisser l’une des poignées d’angle 
du cadre de sélection.
Chacune se déplace alors indépendamment des trois autres poignées d’angle du cadre 
de sélection.
Modification des courbes
La fonction le plus puissante et la plus précieuse offerte par l’Éditeur d’images clés est 
probablement la possibilité d’apporter des modifications aux courbes entre les images 
clés. Evidement, la manipulation d’images clés entraîne la modification des courbes, 
mais Motion vous fournit les outils nécessaires au contrôle de l’interpolation et de 
l’extrapolation des valeurs mêmes de votre paramètre.
Grâce à des algorithmes mathématiques prédéfinis ou en ayant recours à un contrôle 
manuel, vous pouvez modifier de manière significative l’impact de vos effets.
Lorsque vous définissez l’interpolation d’une courbe, vous sélectionnez l’image clé 
à modifier. La méthode que vous choisissez détermine la distribution des valeurs via, 
dans ou en dehors de l’image clé sélectionnée.
Pour définir une méthode d’interpolation pour une image clé :
1 Sélectionnez l’image clé que vous souhaitez affecter. 
L’image clé devient blanche.
2 Appuyez simultanément sur la touche Contrôle et cliquez sur l’image clé pour afficher 
le menu contextuel.
3 Choisissez une méthode d’interpolation dans le sous-menu Interpolation.596 Chapitre 6 Images et clés et courbes
Pour définir une méthode d’interpolation sur un segment de courbe :
m Cliquez sur le segment en maintenant la touche Contrôle enfoncée, puis choisissez 
une méthode d’interpolation dans le sous-menu Interpolation.
Vous pouvez définir différentes méthodes d’interpolation pour différents segments 
de la même courbe.
Lorsque différentes méthodes d’interpolation sont appliquées aux différents segments 
d’une courbe d’animation, les méthodes utilisées dans la courbe apparaissent avec 
un trait d’union en regard de leur nom dans le sous-menu Interpolation (dans la liste 
des paramètres de l’Éditeur d’images clés). Dans l’image suivante, toutes les méthodes 
d’interpolation sont appliquées à la courbe sélectionnée.Chapitre 6 Images et clés et courbes 597
Les différentes méthodes d’interpolation sont décrites dans le tableau suivant.
Méthode d’interpolation Exemple Description
Constante Maintient l’image clé à sa valeur actuelle 
lorsqu’elle est appliquée à un segment 
ou à une image clé, puis prend subitement 
la nouvelle valeur lorsque l’image clé suivante 
est générée.
Linéaire Lors de l’application à une image clé, crée une 
distribution uniforme des valeurs dans l’image 
clé, à partir de ses deux images clés adjacentes. Lors de l’application à un segment, 
crée une distribution uniforme des valeurs 
entre les deux points.
Bézier Vous permet de manipuler la courbe d’images 
clés manuellement en faisant glisser les poignées. Si plusieurs images clés Bézier sont 
sélectionnées, ou que Bézier est appliqué au 
segment de courbes, les poignées de toutes 
les images clés sélectionnées sont modifiées.
En continu Cette méthode fonctionne comme l’interpolation Bézier, mais sans accès aux poignées 
(elles sont calculées automatiquement). 
Le paramètre commence à changer progressivement, et atteint sa vitesse maximum au 
milieu, puis sa vitesse diminue lorsqu’il approche de la seconde image clé. Lorsqu’il est 
appliqué à une image clé, les segments avant 
et après l’image clé sont modifiés. Lorsqu’il est 
appliqué à un segment de courbe, le segment 
entre les deux images clés est modifié.
Atténuation en entrée Type d’effet d’inertie inversée, de sorte qu’un 
changement de valeur entre progressivement 
dans une image clé. Lorsqu’il est appliqué à un 
segment courbe, le changement de valeur 
entre dans le segment.
Atténuation en sortie Crée un retard de type inertie, de sorte qu’un 
changement de valeur commence plus lentement lors de la sortie d’une image clé. Lorsqu’il 
est appliqué à un segment courbe, le changement de valeur sort du segment.598 Chapitre 6 Images et clés et courbes
Vous pouvez également appliquer une méthode d’interpolation sur le paramètre 
complet. Dans l’exemple suivant, la courbe Position Y (verte) est définie sur Bézier.
Pour changer la méthode d’interpolation d’un paramètre entier :
m Dans l’Éditeur d’images clés, cliquez sur le menu Animation, puis choisissez 
une méthode dans le sous-menu Interpolation.
Exponentielle Crée une courbe exponentielle entre la valeur 
actuelle et la suivante, en commençant 
par modifier la valeur actuelle très lentement, 
puis en atteignant le taux d’accélération maximale à l’approche de la valeur suivante.
Logarithmique Crée une courbe logarithmique entre la valeur 
actuelle et la suivante, en commençant 
par modifier la valeur actuelle très rapidement, 
puis en ralentissant de manière considérable 
à l’approche de la valeur suivante.
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La méthode d’interpolation sélectionnée (Constante dans cet exemple) est appliquée 
à la courbe entière.
Pour changer la méthode d’interpolation de plusieurs paramètres :
1 Dans la liste des paramètres de l’Éditeur d’images clés, maintenez la touche Maj 
enfoncée et cliquez sur les paramètres que vous souhaitez modifier.
2 Cliquez sur le menu Animation (dans l’Éditeur d’images clés), puis choisissez 
une méthode dans le sous-menu Interpolation.
La méthode d’interpolation choisie est appliquée à toutes les courbes sélectionnées.
Conversion en Bézier
La méthode d’interpolation de Bézier est la méthode la plus flexible puisqu’elle permet 
une modification manuelle de la courbe. Motion vous permet de convertir rapidement 
et facilement une image clé quelconque en une image clé de Bézier. 
Pour convertir une image clé en image clé de Bézier :
m Tout en maintenant la touche commande enfoncée, faites glisser l’image clé à convertir 
dans le graphique. 600 Chapitre 6 Images et clés et courbes
Les poignées de Bézier apparaissent et le mouvement de votre souris contrôle 
automatiquement l’une des poignées.
Remarque : si vous maintenez la touche Commande enfoncée tout en cliquant sur 
un point de Bézier, vous rétablissez une interpolation linéaire.
Pour modifier simultanément les poignées de plusieurs points de contrôle, cliquez 
sur ces points tout en maintenant la touche Maj enfoncée, puis ajustez les tangentes. 
Si un point ne comporte aucune tangente, faites-le glisser tout en maintenant la touche 
Commande enfoncée. 
Pour séparer une poignée :
m Faites glisser la poignée tout en maintenant la touche Option enfoncée.
Pour verrouiller l’angle d’une poignée lors de vos modifications :
m Faites glisser la poignée tout en maintenant la touche Option enfoncée.
Extrapolation
En plus de définir l’interpolation pour les zones entre les images clés, vous pouvez définir 
la manière dont Motion génère les valeurs avant la première image clé et après la dernière (extrapolation). Lorsque vous définissez une telle méthode sur un paramètre, 
de nouvelles images clés sont ajoutées au-delà de vos images clés d’origine. Cela peut 
se révéler utile lorsque vous essayez d’allonger la durée d’un effet tel que le déplacement de l’arrière-plan. Chapitre 6 Images et clés et courbes 601
Pour appliquer le réglage Avant la première image clé à un paramètre :
m Dans l’Éditeur d’images clés, cliquez sur le menu Animation du paramètre que vous 
souhaitez modifier, puis choisissez un élément dans le sous-menu Avant la première 
image clé.
Pour appliquer le réglage Après la dernière image clé à un paramètre :
m Dans l’Éditeur d’images clés, cliquez sur le menu Animation du paramètre que vous 
souhaitez modifier, puis choisissez un élément dans le sous-menu Après la dernière 
image clé.
Le tableau suivant décrit les options d’extrapolation disponibles dans les sous-menus 
Avant la première image clé et Après la dernière image clé.
Méthode d’extrapolation Exemple Description
Constante (Par défaut) Le paramètre reste à la valeur 
exacte de la première et de la dernière 
image clé dans la zone d’extrapolation.
Linéaire Étend la courbe au-delà de la première et 
de la dernière image clé uniformément, 
le long de la trajectoire. 
Ping-Pong Copie la courbe et la répète, d’avant en 
arrière.602 Chapitre 6 Images et clés et courbes
Génération d’images clés
En règle générale, l’extrapolation n’implique pas la création de nouvelles images clés. 
Cela vous permet d’expérimenter différentes méthodes. Toutefois, vous pouvez convertir une méthode d’extrapolation en images clés réelles afin de pouvoir les manipuler. 
Pour cela, utilisez la commande Générer des images clés. Vous pouvez alors choisir 
le nombre de cycles d’extrapolation que vous souhaitez convertir en images clés. 
Les cycles après le nombre choisi demeurent à l’état extrapolé.
Répétition Duplique la courbe, et l’applique de 
manière répétitive.
Progressive Étend la courbe en répétant sa forme 
existante, mais au lieu de recommencer 
avec les mêmes valeurs, elle recommence avec la valeur de fin existante.
Méthode d’extrapolation Exemple Description
Générer des images clés appliquées sur un cycle
Graphique d’image clé d’origine
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Pour convertir des données d’extrapolation en images clés :
1 Dans le menu Animation, sélectionnez « Générer des images clés » dans le sous-menu 
« Avant la première image clé » ou « Après la dernière image clé ».
La zone de dialogue « Générer des images clés » apparaît.
2 Choisissez le nombre de cycles que vous souhaitez animer avec des images clés. 
3 Cliquez sur OK pour confirmer votre sélection.
Boutons de commande
Dans la fenêtre de l’Éditeur d’images clés, plusieurs boutons garantissent un plus ample 
contrôle : Magnétisme, « Afficher la forme d’onde audio » et « Ajuster les courbes visibles à la fenêtre ».
Magnétisme : lorsque le magnétisme est activé, les images clés se magnétisent aux 
marqueurs, aux autres images clés et aux autres éléments auxquels elles peuvent 
s’accrocher.
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Afficher la forme du signal audio : active l’affichage des formes d’ondes audio de 
l’élément sélectionné à l’arrière-plan du graphique. Cela vous permet d’aligner un effet 
pour qu’il se produise au même moment qu’un événement de la bande audio.
Remarque : si votre projet comporte plusieurs pistes audio, un menu local situé en bas 
de l’Éditeur d’images clés vous permet de visualiser la forme d’onde de toute piste audio 
de votre projet ou de la piste Master.
Ajuster les courbes visibles à la fenêtre : redimensionne automatiquement le graphique à la verticale, afin qu’il inclut toutes les images clés de vos paramètres activés.
Il est possible que les valeurs de vos images clés dépassent la résolution verticale 
du graphique. Par exemple, lorsque vous allongez une image clé, vous pouvez la faire 
glisser si loin que vous forcez la fenêtre à défiler.
« Afficher la forme du signal audio » activéChapitre 6 Images et clés et courbes 605
Lorsque vous cliquez sur ce bouton, Motion redimensionne automatiquement le graphique à la verticale comme à l’horizontale, afin que votre courbe soit entièrement visible.
Toutefois, les valeurs de vos images clés ne sont pas modifiées. 
Ajustement vertical automatique : cliquez sur ce bouton (la loupe dans le coin supé-
rieur droit de l’Éditeur d’images clés) pour étirer le graphique de telle sorte que toutes 
les courbes actuellement à l’écran soient visibles.
Pour activer le mode de mise à l’échelle automatique :
m Cliquez sur le bouton Ajustement vertical automatique dans le coin supérieur droit 
de l’Éditeur d’images clés.
Lorsque l’option Ajustement vertical automatique est activée, la plage du graphique 
augmente pour s’adapter à la totalité de votre courbe, au fur et à mesure que vous la 
modifiez. Par exemple, si vous faites glisser une image clé vers le haut pour augmenter 
sa valeur, si vous dépassez le haut de la fenêtre, tout le graphique est remis à l’échelle 
au lieu de défiler. 
Cela peut s’avérer déconcertant au premier abord, car il semble que votre courbe 
refuse de s’agrandir même si vous faites glisser votre image clé. Toutefois, si vous 
observez la barre de zoom/défilement du côté droit de la fenêtre, vous constatez qu’un 
zoom vertical est effectué sur le graphique, afin de libérer de l’espace pour une plage 
de valeurs plus importante.
Bouton « Ajuster les courbes 
visibles à la fenêtre »
Bouton Ajustement
vertical automatique606 Chapitre 6 Images et clés et courbes
Éditeur de mini-courbes
Un éditeur de mini-courbes est une version limitée de l’Éditeur d’images clés. Affichés par 
l’Inspecteur, les éditeurs de mini-courbes vous offrent la possibilité de créer des animations 
de base directement dans l’Inspecteur, sans avoir à ouvrir l’Éditeur d’images clés. 
Deux comportements Particule, Échelle sur longévité et Rotation sur longévité, disposent 
d’éditeurs de mini-courbes dans l’Inspecteur (lorsque leur paramètre Type d’incrément 
est réglé sur Personnaliser). La fenêtre Trait de l’Inspecteur Forme affiche également 
des éditeurs de mini-courbes pour les objets peints.
Par défaut, l’éditeur de mini-courbes est réduit et affiche une représentation limitée 
de la courbe d’animation actuelle.
Pour développer un éditeur de mini-courbes :
m Cliquez sur le triangle d’affichage situé en regard de l’éditeur de mini-courbes réduit.
L’éditeur de mini-courbes développé apparaît alors.
Éditeur de mini-courbes réduit
Outil Esquisse
Outil Cadre
Outil Édition
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Une fois développé, l’éditeur de mini-courbes affiche une représentation de la courbe 
d’animation correspondante. Dans l’exemple ci-dessus, les paramètres Plage et Quantité 
de rotation correspondent respectivement aux axes X et Y.
Pour ajouter des images clés dans un éditeur de mini-courbes, la procédure diffère 
légèrement de celle utilisée dans l’Éditeur d’images clés intégral.
Pour ajouter des images clés dans l’éditeur de mini-courbes, procédez de l’une 
des manières suivantes :
m Cliquez sur la courbe dans l’éditeur de mini-courbes.
m Double-cliquez sur la courbe dans l’éditeur de mini-courbes afin d’ajouter une image 
clé et d’activer son champ de valeur.
m Cliquez sur la courbe tout en maintenant la touche Option enfoncée, puis choisissez 
« Ajouter une image clé » dans le menu contextuel.
L’éditeur de mini-courbes vous propose les mêmes outils Édition, Esquisse et Cadre, 
ainsi que les mêmes fonctions que l’Éditeur d’images clés. Pour en savoir plus sur l’utilisation de l’outil Édition, voir « Utilisation de l’outil Édition » à la page 587. Pour l’outil 
Esquisse, voir plutôt « Utilisation de l’outil Esquisse » à la page 592. Quant à l’outil Cadre, 
voir « Utilisation de l’outil Cadre » à la page 593.
La case à cocher Ajustement auto permet d’indiquer à Motion s’il doit automatiquement 
mettre à l’échelle la courbe d’animation pour l’adapter aux limites de l’éditeur de minicourbes.
Case Ajustement auto désactivée dans 
l’éditeur de mini-courbesAnimation à la volée
Une autre fonction puissante offerte par Motion est la capacité de créer des animations 
tandis que votre projet est en cours de lecture. Cette méthode s’apparente à la manière 
dont les ingénieurs audio règlent les curseurs pour chacun des canaux audio tout en 
écoutant leur mixage. Lors de la lecture suivante, toutes les modifications sont incorporées.
Comme de nombreux effets de Motion sont affichés en temps réel, vous pouvez exécuter une sorte de « mixage visuel » et modifier les différents paramètres de vos effets en 
cours de lecture de votre projet.
Il vous faut alors visualiser l’ensemble des éléments de votre projet en interaction pour 
savoir si chaque partie se comporte comme prévu. Un objet peut subir un fondu trop 
lent et entraîner une mauvaise visibilité d’un autre élément ou un élément de texte 
peut apparaître et disparaître si rapidement qu’il est impossible de le lire. Grâce à l’insertion d’images clés à la volée, vous pouvez effectuer des réglages sur tous les curseurs 
ou tous les paramètres du programme lors de lecture de votre projet. Vous pouvez également manipuler de manière interactive des objets dans le Canevas. Ensuite, si vous 
n’aimez pas le résultat, rembobinez et recommencez. À chaque fois que vous modifiez 
un paramètre, vous remplacez toutes les images clés précédemment définies. 
Pour animer un paramètre à la volée en utilisant l’Inspecteur ou la palette :
1 Cliquez sur le bouton Enregistrer (ou appuyez sur A) ou choisissez Marquer > 
Enregistrer l’animation afin d’activer l’enregistrement des images clés.
2 Cliquez sur le bouton de lecture ou appuyez sur la Barre d’espace pour lancer la lecture.
3 Lors de la lecture de votre projet, réglez le curseur d’un paramètre.
4 Désactivez l’enregistrement.
Les modifications apportées en cours de lecture sont enregistrées comme des images 
clés pour ce paramètre. Vous pouvez les afficher dans l’Éditeur d’images clés.Chapitre 6 Images et clés et courbes 609
Si vous n’aimez pas votre animation, vous pouvez supprimer les images clés et réessayer. 
Choisissez alors Édition > Annuler (ou appuyez sur les touches Commande + Z) pour 
revenir à l’état précédant le début de l’enregistrement de votre animation ou supprimez 
manuellement les images clés que vous souhaitez remplacer.
Pour supprimer des images clés, exécutez l’une des opérations suivantes :
m Sélectionnez l’image clé, puis cliquez sur Supprimer.
m Appuyez simultanément sur la touche Contrôle et cliquez sur l’image clé, puis sélectionnez 
Supprimer dans le menu contextuel.
m Sélectionnez l’image clé, puis sélectionnez Supprimer dans le menu Animation de 
ce paramètre.
Remarque : pour supprimer toutes les images clés pour un paramètre, choisissez Réinitialiser le paramètre dans le menu Animation de la liste Éditeur d’images clés ou de l’Inspecteur.
Animation manuelle dans le Canevas
L’une des utilisations les plus courantes de l’animation à la volée est la création 
manuelle de trajectoires d’animation. Même si vous pouvez choisir parmi une variété 
de types de courbes, il est vraiment difficile d’obtenir un mouvement semi-aléatoire, 
sauf en le dessinant avec votre souris ou votre crayon.
Pour créer une trajectoire d’animation manuelle dans le Canevas :
1 Activez l’enregistrement (appuyez sur la touche A).
2 Cliquez sur le bouton de lecture pour commencer la lecture. 
3 Sélectionnez l’objet que vous souhaitez manipuler et déplacez-le selon le tracé de 
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La position et la vitesse de votre mouvement sont enregistrés et appliquées aux positions 
des images clés de cet objet.
Vous pouvez manipuler encore plus la trajectoire soit en faisant glisser des images clés 
individuelles ou en enregistrant de nouveau une nouvelle trajectoire d’animation pour 
cet objet.
Suppression d’images clés
Du fait du fonctionnement des images clés, si la tête de lecture se trouve sur une nouvelle image et que vous définissez une nouvelle valeur pour un paramètre, une image 
clé est alors ajoutée. Pour animer la séquence lors de la lecture du projet, il peut être 
nécessaire de définir une nouvelle image clé pour chacune des images. Cela ne pose 
aucun problème jusqu’à ce que vous souhaitiez modifier la courbe. 
Dans de nombreux cas, la courbe créée par votre animation peut être représentée 
à l’aide de moins d’images clés. Souvent, vous obtiendrez un changement plus progressif et vous pourrez tirer partie des différentes méthodes d’interpolation, telles que 
l’Atténuation en entrée et l’Atténuation en sortie.
Les images clés très proches les 
unes des autres indiquent un mouvement plus lent. 
Les images clés très éloignées 
les unes des autres indiquent 
un mouvement rapide.Chapitre 6 Images et clés et courbes 611
Il existe deux méthodes de simplification des images clés : soit lorsque vous les enregistrez, soit ultérieurement en simplifiant une courbe d’animation existante. Pour en savoir 
plus sur la simplification des images clés après l’enregistrement grâce à la commande 
Réduire les images clés, voir page 578.
Options d’enregistrement
La zone de dialogue Options d’enregistrement vous permet de définir le réglage 
Suppression d’images clés, d’enregistrer uniquement les paramètres déjà animés 
ou de désactiver l’enregistrement au cours de la lecture.
Le paramètre Suppression d’images clés ne s’applique qu’à l’enregistrement d’animation 
en cours de lecture. Ce paramètre n’a aucun effet sur l’insertion ordinaire d’images clés.
Pour accéder aux options d’enregistrement, procédez de l’une des manières suivantes :
m Choisissez Marquer > Options d’enregistrement (ou appuyez sur les touches Option + A).
m Double-cliquez sur le bouton Animer.
La zone de dialogue Options d’enregistrement apparaît.
Pour définir le réglage Suppression d’images clés :
1 Sélectionnez Désactivé, Réduite ou Pics uniquement. 
2 Cliquez sur OK.
Option Réduire les images clés (dans le menu Animation de l’Éditeur d’images clés) 
appliquée à la Position Y612 Chapitre 6 Images et clés et courbes
Désactivé : aucune suppression n’est appliquée. Les images clés sont appliquées sur 
chaque image dont le paramètre est modifié.
Réduite : Motion élimine les images clés qui peuvent être facilement remplacées 
par une simple courbe. 
Pics uniquement : seules les images clés dont les modifications sont significatives 
sont enregistrées. Chapitre 6 Images et clés et courbes 613
Désactivation de l’animation en cours de lecture
Si vous laissez le bouton Enregistrer activé, des images clés sont ajoutées à chaque fois 
que vous effectuez des réglages. Si vous souhaitez limiter les images clés au moment 
où le projet n’est pas en cours de lecture, vous pouvez désactiver cette fonction 
individuellement.
Pour désactiver l’enregistrement de l’animation en cours de lecture :
1 Sélectionnez Marquer > Options d’enregistrement. 
La zone de dialogue Options d’enregistrement apparaît.
2 Activez l’option « Ne pas enregistrer d’images clés durant la lecture ».
3 Cliquez sur OK.
Enregistrement d’images clés sur les paramètres animés uniquement
Lorsque l’option « Enregistrer les images clé sur les paramètres animés seulement » 
est activée, les images clés sont ajoutées uniquement aux paramètres déjà animés. 
Par exemple, si la position d’une forme est animée (avec images clés) et que l’option 
« Enregistrer les images clé sur les paramètres animés seulement » est activée, seules 
les modifications apportées à la position de cet objet font l’objet d’images clés. Si vous 
changez la couleur de l’objet dans le temps, les changements de couleur ne font pas 
l’objet d’images clés, même lorsque le bouton Enregistrer est activé.
Important : le bouton Enregistrer doit être activé lors de l’utilisation de l’option 
« Enregistrer les images clé sur les paramètres animés seulement ». Vous pouvez 
toujours ajouter manuellement des images clés, que l’option Enregistrer soit activée 
ou non, via le menu Animation de l’Inspecteur ou de la liste de l’Éditeur d’images clés, 
ou en appuyant sur les touches Option + K.
∏ Conseil : si vous utilisez Final Cut Pro, il est recommandé d’utiliser cette option 
pour émuler le flux de travaux avec lequel vous êtes familiarisé.
Pour enregistrer des images clés sur les paramètres animés uniquement :
1 Activez l’enregistrement (ou appuyez sur la touche A).
2 Choisissez Marquer > Options d’enregistrement (ou appuyez sur les touches Option + A). 
3 Activez l’option « Enregistrer les images clé sur les paramètres animés seulement ».
4 Cliquez sur OK.
Les images clés sont à présent ajoutées uniquement lorsque vous apportez des 
modifications à des paramètres animés. Pour observer le fonctionnement de l’option 
« Enregistrer les images clé sur les paramètres animés seulement », parcourez le petit 
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Pour voir l’option « Enregistrer les images clé sur les paramètres animés seulement » 
en action :
1 Activez l’enregistrement (appuyez sur la touche A).
2 Choisissez Marquer > Options d’enregistrement et assurez-vous que l’option 
« Enregistrer les images clé sur les paramètres animés seulement » est désactivée 
dans la zone de dialogue Options d’enregistrement, puis cliquez sur OK.
3 À l’image 1 (appuyez sur Début), dessinez une forme dans le Canevas et déplacez 
l’objet à une position de départ.
Une image clé de position est créée. 
4 Avancez jusqu’à une image différente et déplacez l’objet vers une autre position.
Une deuxième image clé de position est créée.
5 Choisissez Marquer > Options d’enregistrement et activez l’option « Enregistrer 
les images clés sur les paramètres animés seulement » dans la zone de dialogue 
Options d’enregistrement, puis cliquez sur OK.
6 Accédez à une image entre les deux images clés de position, puis déplacez la forme 
dans le Canevas.
Une troisième image clé de position est ajoutée.
7 Au niveau de l’image 1 (appuyez sur la touche Début), cliquez sur le cadre de couleur 
Remplissage dans la palette de la forme, puis modifiez la couleur de l’objet.
8 Avancez jusqu’à une autre image, puis changez de nouveau l’objet de couleur.
9 Accédez à l’image 1 et cliquez sur le bouton de lecture (ou appuyez sur la barre espace).
La position de l’objet est animée, mais pas sa couleur, car la forme comportait des 
images clés de position lorsque l’option « Enregistrer les images clés sur les paramètres 
animés seulement » était activée.
Cadre de couleur Remplissage7
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Le texte, l’un des éléments les plus importants dans 
les animations, offre encore plus d’options de personnalisation 
dans Motion.
Dans le domaine de l’animation graphique, les textes transmettent un message bien 
plus important que de simples informations de base, telles que des titres, des dates 
ou des repères. L’apparition de caractères typographiés à l’écran peut même engendrer une réponse émotionnelle immédiate et puissante. Aujourd’hui, la simple 
séquence de générique d’un film laisse deviner son atmosphère, quelques mots et des 
styles d’animation particuliers permettent de reconnaître immédiatement une chaîne 
et une publicité interstitielle bien pensée incite le téléspectateur à lâcher sa télécommande. C’est devenu une forme d’art. Jetez juste un œil au générique de Friz Freleng 
pour La Panthère Rose de Blake Edwards. Les titres animés créés par Freleng, basés sur 
un design et un style graphique qui ont su traverser le temps et résister à plus de 
40 ans d’effets spéciaux, ne définissent pas seulement le ton comique du film, ils sont 
à l’origine de la carrière (certes virtuelle) d’une véritable icône (avec l’aide, il faut bien 
l’avouer, du très ingénieux thème musical d’Henry Mancini).
Bien que l’usage fait des textes ne cesse d’évoluer, le juste équilibre entre texte 
et graphisme reste la clé pour atteindre l’effet souhaité en matière de publicités, 
documentaires, génériques d’émissions de télévision ou de films, logos, présentations 
d’entreprise ou pour vos propres projets vidéo.
Peu importe le style que vous souhaitez développer dans votre projet, Motion vous offre 
des outils d’animation de texte hors du commun, qui vous permettent d’obtenir 
des résultats immédiats.616 Chapitre 7 Utilisation de texte
Utilisation de texte dans Motion
Dans Motion, vous avez la possibilité d’ajouter du texte à votre projet directement 
dans le Canevas (sélectionnez l’outil Texte, cliquez dans le Canevas, puis commencez à 
saisir). Une fois le texte créé, vous pouvez le modifier dans le Canevas ou dans l’éditeur 
de texte de l’Inspecteur.
Vous pouvez également animer du texte grâce à des comportements ou à des images clés. 
Le texte dispose à cet effet de deux catégories de comportements spéciaux : les comportements Animation de texte et Séquence de texte. Ils animent le texte en générant une plage 
de valeurs dans les paramètres de texte spécifiques aux effets de titrage. Faites par exemple 
glisser sur un texte le comportement Suivi du texte et ses caractères se disperseront avec 
élégance sur le Canevas, sans nécessiter la moindre image clé. (Vous pouvez choisir de travailler avec ou sans images clés à l’aide des comportements Séquence de texte et Animation de texte.)
En dehors des comportements Texte, vous pouvez appliquer n’importe quel comportement Animation standard, Simulation ou Paramètre à du texte. Pour en savoir plus sur 
ces types de comportements, voir « Utilisation des comportements » à la page 405.
Même si ces comportements sont conçus pour des graphiques, ils constituent 
une méthode idéale pour tester différents traitements appliqués à du texte, sans avoir 
à régler d’images clés. Il vous suffit d’ouvrir la palette du comportement appliqué 
pour ajuster rapidement sa fréquence et observer la mise à jour de l’animation dans 
le Canevas. Pour une plus grande maîtrise, vous pouvez accéder à tous les paramètres 
d’un comportement dans l’Inspecteur. Si votre projet nécessite un contrôle du temps 
et un positionnement particuliers pour votre texte, recourez encore aux comportements 
pour tester des effets, puis créez des images clés dès que vous savez exactement quel 
résultat vous souhaitez obtenir. Vous pouvez aussi créer des images clés à partir des 
comportements de texte appliqués en utilisant la fonction «Convertir en images clés ». 
Cette approche vous permet de peaufiner l’animation créée par les comportements 
appliqués au texte.
Les comportements ne sont en aucun cas une nécessité pour animer du texte. 
Vous pouvez créer une animation de texte par le biais de la méthode traditionnelle 
d’ajout d’images clés ou en combinant ces deux techniques. 
Remarque : bien que vous puissiez combiner l’application d’images clés et de comportements à du texte, réfléchissez à l’effet que vous tentez de créer. En effet, leur combinaison 
peut nuire à l’intérêt des comportements et provoquer des résultats inattendus. Pour en 
savoir plus sur la combinaison de comportements et d’images clés, voir « Utilisation des 
comportements » à la page 405.
Le texte peut être positionné et animé sur une trajectoire, servir de source à un masque 
d’image ou de source de cellule à un émetteur de particules ou à un réplicateur.Chapitre 7 Utilisation de texte 617
Dès que vous obtenez le traitement de texte recherché (un comportement de texte 
personnalisé ou un style de texte avec un éclat et des couleurs de dégradé parfaits), 
vous pouvez enregistrer le comportement ou le style dans la Bibliothèque pour 
l’appliquer à un autre texte ou dans un projet futur.
Vous pouvez appliquer des filtres à du texte, ainsi que modifier et animer ses propriétés, 
notamment sa position, ses modes de fusion et ses ombres portées.
Il est également possible de modifier très simplement l’ordre du texte dans la pile via 
l’onglet Couches ou la Timeline. Vous pouvez même le déplacer ou le dupliquer/copier 
dans une autre couche.
La Bibliothèque Motion vous propose dix polices LiveFonts que vous pouvez appliquer 
à du texte. Les LiveFonts sont des polices animées qui peuvent doter votre projet 
d’un peu de vitalité.
Style de texte personnalisé enregistré 
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Remarque : si Final Cut Pro est installé avec LiveType, toutes les LiveFonts apparaissent 
dans la Bibliothèque de Motion.
Réglage de préférences relatives à la durée des couches
Avant de commencer le moindre projet, vous devez régler les préférences Motion 
en fonction de vos besoins. Si vous manipulez du texte, vous pouvez ainsi indiquer 
qu’un objet (une couche de texte) doit toujours être créé au niveau de l’image en cours 
(l’image sur laquelle est positionnée la tête de lecture quand vous ajoutez le texte). 
À l’inverse, vous pouvez choisir de toujours créer les objets au début du projet. 
Par défaut, les couches sont créées au niveau de l’image en cours. Vous avez également 
la possibilité d’indiquer une durée par défaut pour toutes les couches créées.
Remarque : vous définissez alors les mêmes préférences pour toutes les couches créées 
dans Motion, qu’il s’agisse de texte, de formes, de masques, d’émetteurs de particules 
ou de réplicateurs. 
Pour définir les préférences de durée des couches :
1 Choisissez Motion > Préférences (ou appuyez sur touches Commande + virgule).
2 Cliquez sur l’icône Projet.
La fenêtre des préférences du projet s’affiche.
3 Dans la section Images et couches, définissez la préférence Durée de couche par défaut :
Â Pour créer du texte de même durée que le projet, sélectionnez « Utiliser la durée du 
projet » (réglage par défaut). Ainsi, si vous travaillez dans un projet comptant 300 images 
et que vous créez un texte, ce dernier a également une durée de 300 images.
Remarque : en revanche, si vous avez sélectionné « Sur l’image actuelle » pour l’option 
« Créer couches à » et que vous créez un texte sur l’image 50, ce texte existe des 
images 50 à 300.
Â Pour créer un texte d’une durée déterminée, optez pour « Utiliser une durée 
personnalisée ». Ensuite, introduisez une valeur dans le champ de texte, 
puis choisissez Images ou Secondes dans le menu local. 
Par défaut, la durée de toutes les couches créées correspond à la valeur indiquée.
Utilisation d’un texte comme objet source d’un émetteur de particules 
ou d’un réplicateur
Les couches de texte peuvent servir de cellules source pour des émetteurs de particules 
et des réplicateurs. Vous créez alors très rapidement des graphiques saisissants. 
Si vous modifiez par la suite le texte source, Motion met à jour automatiquement 
le réplicateur ou le système de particules concerné. Par ailleurs, si des comportements 
ou des filtres sont appliqués au texte servant de source de cellule, leur effet est 
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4 Définissez la préférence « Créer couches à :» 
Â Pour créer du texte à l’emplacement actuel de la tête de lecture, sélectionnez 
« Sur l’image actuelle ».
Â Pour créer du texte au début de votre projet, sélectionnez « Au début du projet ». 
Dans ce cas, tout texte ajouté est créé par défaut au début du projet, quelle que soit 
la position de la tête de lecture.
Utilisation du texte
Dans Motion, vous pouvez créer du texte directement dans le Canevas à l’aide de l’outil 
Texte. Après avoir ajouté du texte à votre projet, vous pouvez facilement lui appliquer 
des filtres ou l’animer à l’aide de comportements ou d’images clés.
Création de texte dans votre projet
Cette rubrique décrit comment ajouter du texte à votre projet dans le Canevas.
Si l’option « Créer couches à » est réglée sur « Au début du projet » dans les préférences 
du projet, le texte ajouté est créé sur la première image du projet. Ainsi, si vous travaillez 
dans un projet comptant 900 images et que vous créez un texte, ce dernier a également 
une durée de 900 images. Pour réduire sa durée, raccourcissez la durée de la couche 
de texte dans la Timeline ou la mini-Timeline. Pour en savoir plus, voir « Utilisation de 
la Timeline » à la page 353.
Pour ajouter du texte dans le Canevas :
1 Dans la liste de couches, sélectionnez le groupe auquel vous souhaitez ajouter la couche 
de texte.
Remarque : si vous ne sélectionnez aucun groupe, le texte est ajouté au dernier groupe 
sélectionné (le groupe dont le nom est souligné).
Options disponibles pour 
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2 Dans la barre d’outils, cliquez sur l’outil Texte (ou appuyez sur T).
3 Cliquez dans le Canevas.
Le curseur clignote dans le Canevas au point d’insertion. Avant de saisir le moindre 
texte, une couche de texte vide est ajoutée au projet et la palette Texte apparaît.
4 Tapez le texte souhaité.
Le texte apparaît alors dans le Canevas, l’onglet Couches et la Timeline.
Remarque : par défaut, la méthode de présentation du texte est définie sur Type. 
Comme l’option de présentation Ligne ne crée pas de marge, si vous tapez une longue 
chaîne de texte, celle-ci s’étend sur une seule ligne au-delà du Canevas jusqu’à ce que 
vous introduisiez un saut de ligne (appuyez sur Entrée). Ce mode est pratique lorsque 
vous utilisez des textes courts et souhaitez effectuer un panoramique sur le texte dans 
le Canevas. Pour en savoir plus sur le changement de présentation du texte ou sur 
le réglage des marges, consultez « Commandes Présentation du texte » à la page 683.
Remarque : pour visualiser les éléments situés au-delà des limites du Canevas, choisissez 
Présentation > Afficher zone de présentation totale.
5 Une fois que le texte est créé, appuyez sur Échap ou cliquez sur l’outil Sélectionner/
Transformer.
Le texte est sélectionné et entouré d’un cadre de sélection dans le Canevas. Le nom 
de la couche est mis à jour pour tenir compte du texte saisi.
Outil Texte
Couche de texte vide
Séquence mise à disposition avec l’aimable autorisation 
de National Geographic Television et Film Library.Chapitre 7 Utilisation de texte 621
Important : quand vous avez fini de taper votre texte, veillez à appuyer sur Échap ou 
à sélectionner un autre outil dans la barre d’outils (n’utilisez pas de raccourci clavier). 
En effet, quand l’outil Texte est sélectionné, vous êtes en mode texte, donc si vous 
appuyez sur S pour sélectionner l’outil Sélectionner/Transformer, un « S » est ajouté 
à votre texte au lieu de modifier l’outil.
Texte sous forme de couche
Une fois créé, le texte devient une couche. Comme les couches de texte partagent 
la majeure partie de leurs caractéristiques avec d’autres couches de Motion, vous 
pouvez utiliser les outils de transformation (Sélectionner/Transformer, Point d’ancrage, 
Déformation, Ombre portée, Quatre angles et Rognage) pour transformer une couche 
de texte sélectionnée, si la case Aplatir est cochée dans la sous-fenêtre Présentation 
de l’Inspecteur Texte. Ces outils à l’écran sont en fait des raccourcis pour accéder aux 
commandes relatives aux couches disponibles sous l’onglet Propriétés de l’Inspecteur. 
Pour attribuer des valeurs spécifiques à une transformation ou la régler précisément, 
utilisez l’onglet Propriétés de l’Inspecteur.
Pour en savoir plus sur l’onglet Propriétés et les outils de transformation à l’écran, 
voir « Paramètres disponibles dans l’onglet Propriétés » à la page 312. Pour en savoir plus 
sur la case à cocher Aplatir, voir « Commandes Présentation du texte » à la page 683.
Remarque : lorsque vous apportez des modifications à un texte à l’aide des outils 
de transformation à l’écran ou des paramètres présents dans l’onglet Propriétés 
de l’Inspecteur, ces modifications s’appliquent au texte en tant que couche (comme 
dans le cas d’un plan ou d’une image) et non en tant que texte modifiable. Les commandes servant à modifier le texte en soi sont situées sous l’onglet Texte de l’Inspecteur. Bien que certaines propriétés de la couche soient similaires à des commandes 
de format et de style de texte, comme Déformer (sous l’onglet Propriétés) et Talus 
(dans la fenêtre Format de l’onglet Texte), les propriétés de la couche sont indépendantes 
des commandes de format de texte, et inversement. Par exemple, si vous appliquez 
une valeur de talus de 20 dans la fenêtre Format de l’Inspecteur Texte, une valeur 
de talus de 20 est appliquée à chacun des caractères du mot, simulant un style italique. 
De même, si vous appliquez une valeur de déformation de 20 sous l’onglet Propriétés 
de l’Inspecteur (ou via les commandes à l’écran), une valeur de déformation de 20 est 
appliquée à la couche dans son ensemble, et non aux caractères constituant le texte.
La rubrique suivante décrit brièvement de la transformation de texte à l’aide des outils 
de transformation à l’écran. Pour des informations détaillées sur les commandes à 
l’écran, voir « Utilisation des outils de transformation 2D » à la page 294.622 Chapitre 7 Utilisation de texte
Outre la possibilité de déplacer du texte avec les outils de transformation, vous pouvez 
le déplacer vers le haut et vers le bas dans le montage sous l’onglet Couches et dans 
la Timeline. Comme toute autre couche dans Motion, il est possible de copier, coller, 
dupliquer et supprimer du texte. Pour en savoir plus, voir « Gestion des couches de 
votre projet » à la page 243.
Utilisation de la palette Texte
La palette Texte affiche certains des paramètres de texte les plus fréquemment utilisés, 
comme Opacité, Nom de police et Couleur.
Remarque : si la palette Texte n’apparaît pas alors qu’un texte est sélectionné, 
appuyez sur F7 ou D.
Lorsqu’une couche de texte et l’outil Ajuster transformation 3D (dans la barre d’outils) sont 
sélectionnés simultanément, la palette affiche également des outils de transformation 3D. 
Ces commandes supplémentaires vous permettent de transformer l’objet de texte 
selon les axes X, Y et Z, que le groupe soit en 2D ou en 3D.
Pour en savoir plus sur l’utilisation des outils de transformation 3D affichées par la palette, 
voir « Compositing 3D » dans le manuel PDF Documentation supplémentaire de Motion.
La palette Texte met à votre disposition les commandes suivantes :
Opacité : par défaut, l’opacité du texte est réglée sur 100 %. Utilisez le curseur pour 
changer la valeur de l’opacité.
Menu local Nom
de police
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Remarque : l’onglet Propriétés propose également des commandes permettant 
de modifier l’opacité du texte. Ces commandes d’opacité sont indépendantes 
des commandes affichées dans l’onglet Texte de l’Inspecteur. Sous l’onglet Texte, 
vous pouvez contrôler l’opacité de tous les éléments de style de texte, dont la face, 
le contour, l’éclat et l’ombre portée. Sous l’onglet Propriétés, la commande Opacité 
définit la transparence de la couche de texte, quel que soit le style appliqué.
Mode de fusion : par défaut, le mode de fusion du texte est réglé sur Normal. 
Utilisez le menu local Mode de fusion pour affecter un autre mode au texte sélectionné.
Remarque : l’onglet Propriétés propose également des commandes permettant de 
modifier le mode de fusion du texte. Lorsque vous modifiez le mode de fusion d’un 
texte dans la palette Texte, son mode de fusion est également changé sous l’onglet 
Propriétés et inversement.
Nom de police : par défaut, la police utilisée pour le texte est Geneva (si cette police est 
installée sur votre ordinateur). Pour modifier la police du texte sélectionné, choisissez-en 
une autre dans le menu local. Une fois que vous avez sélectionné une police, tout nouveau 
texte est créé avec la dernière police sélectionnée.
Style : choisissez le style, tel que Gras ou Italique, dans le menu local Style. Les styles 
disponibles dépendent de la police sélectionnée.
Couleur : par défaut, la couleur du texte est réglée sur blanc. Cliquez dans le cadre 
de couleur pour afficher la fenêtre Couleurs et affecter une autre couleur au texte sélectionné. Vous pouvez également cliquer sur le cadre de couleur tout en maintenant 
la touche Contrôle enfoncée pour afficher une palette de couleurs, puis faire glisser 
le pointeur sur le spectre pour sélectionner une couleur.
Taille : par défaut, le texte est créé avec une taille égale à 48 points. Pour la changer, 
faites glisser le curseur Taille.624 Chapitre 7 Utilisation de texte
Remarque : les curseurs Taille du texte (affichés dans la palette et l’Inspecteur) 
sont limités à 288 points. Pour agrandir la taille en points du texte, tapez une valeur 
dans le champ Taille, dans la fenêtre Format de l’Inspecteur Texte.
Suivi : applique une valeur d’espace uniforme entre chaque caractère. Le suivi est défini 
sur 0 par défaut. Pour modifier la valeur de suivi du texte, faites glisser le curseur Suivi 
vers la gauche (pour une valeur négative) ou vers la droite (pour une valeur positive). 
Remarque : les curseurs Suivi du texte (affichés dans la palette et l’Inspecteur) sont limités 
à 100 points. Pour définir une valeur de suivi supérieure, tapez un chiffre dans le champ 
Suivi de la fenêtre Format de l’Inspecteur Texte.
Interligne : quand vous manipulez plusieurs lignes de texte, déplacez le curseur pour 
changer l’espace entre les lignes de texte. Un glissement vers la droite (supérieur à 0) 
augmente l’espacement entre les lignes, tandis qu’un glissement vers la gauche 
(inférieur à 0) crée un espacement négatif des lignes.
Alignement : l’alignement du texte est défini par défaut sur la gauche. Pour changer 
l’alignement, choisissez À droite ou Centre dans le menu local Alignement.
Paramètres de texte disponibles dans l’Inspecteur
La totalité des paramètres de texte (y compris les paramètres de la palette Texte) 
est affichée sous l’onglet Texte de l’Inspecteur.
Champ 
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Pour afficher l’Inspecteur :
1 Sélectionnez le texte.
2 Procédez de l’une des manières suivantes :
Â Choisissez Fenêtre > Inspecteur.
Â Cliquez sur le bouton « i » dans la palette.
Â Appuyez simultanément sur les touches Commande + 3.
L’Inspecteur contient tous les paramètres de texte divisés en trois sous-fenêtres : Format, 
Style et Paragraphe. Pour en savoir plus, voir « Modification de texte dans l’Inspecteur » 
à la page 635.
Application de comportements et de filtres à du texte
Pour appliquer des comportements et des filtres à du texte, procédez comme pour toute 
autre couche dans Motion. Cette rubrique présente rapidement la méthode à employer 
pour appliquer des comportements et des filtres à du texte. Pour en savoir plus 
sur l’utilisation des comportements Animation de texte et Séquence de texte, voir 
« Utilisation des comportements Animation et Séquence de texte » à la page 702.
Pour appliquer un comportement à un texte, procédez de l’une des manières suivantes :
m Dans la Bibliothèque, sélectionnez un comportement, puis faites-le glisser sur un texte 
dans le Canevas, l’onglet Couches ou la Timeline.
m Sélectionnez le texte auquel vous souhaitez appliquez un comportement, cliquez sur 
l’icône Ajouter comportement dans la barre d’outils, puis choisissez un comportement 
dans le menu local.
La palette Texte laisse la place à une palette Comportement. 
Remarque : pour en savoir plus sur l’application de comportements de texte, 
voir « Comportements Animation de texte » à la page 703 et « Comportements 
Séquence de texte » à la page 725. Pour en savoir plus sur d’autres comportements, 
voir « Utilisation des comportements » à la page 405.
Icône Ajouter comportement
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Pour appliquer un filtre à un texte, procédez de l’une des manières suivantes :
m Dans la Bibliothèque, sélectionnez un filtre, puis faites-le glisser sur un texte dans 
le Canevas, l’onglet Couches ou la Timeline.
m Sélectionnez le texte auquel vous souhaitez appliquez un filtre, cliquez sur l’icône 
Ajouter filtre dans la barre d’outils, puis choisissez un filtre dans le menu local.
Remarque : pour en savoir plus sur l’utilisation des filtres, voir « Utilisation des filtres » 
à la page 909.
À propos des polices
Motion utilise toutes les polices installées sur votre système Mac OS X. Ce dernier prend 
en charge les polices de type OpenType, Type1 (ou PostScript) et TrueType. Toutes les 
polices prises en charge installées sur votre système apparaissent dans la Bibliothèque, 
ainsi que dans la sous-fenêtre Format de l’Inspecteur Texte. Ces polices sont situées 
dans les dossiers suivants : 
Â /Bibliothèque/Fonts/
Â /Utilisateurs/nom d’utilisateur/Bibliothèque/Fonts/
Â Dossier Système de Classic/Fonts/
Pour en savoir plus sur l’installation de polices, consultez la documentation de votre 
système. Si vous avez installé Final Cut Pro avec les polices LiveType, vous pouvez utiliser 
les polices LiveFonts dans Motion. En revanche, si Final Cut Pro n’est pas installé, sachez 
que Motion inclut dix LiveFonts. Pour en savoir plus sur les polices LiveFonts, consultez 
« Utilisation de polices LiveFonts » à la page 738. 
Vous pouvez prévisualiser et appliquer les polices disponibles dans la Bibliothèque ou 
dans la sous-fenêtre Format de l’Inspecteur Texte.
Utilisation des palettes
Vous pouvez afficher une palette pour n’importe quel objet dans Motion. Pour ce faire, 
sélectionnez un objet (groupe, couche, filtre, comportement, caméra, etc.), puis appuyez 
sur F7 (ou sur D). La palette affichée est en rapport avec l’objet actuellement sélectionné. 
Les paramètres qu’elle contient dépendent du type d’objet sélectionné. Par exemple, 
la palette relative à un texte affiche des paramètres propres aux objets texte, tels que 
Style et Interligne. Quant à la palette d’un émetteur de particules, elle affiche des 
commandes propres à ce type d’objet, comme Source d’émission, Longévité et Échelle.
À mesure que vous ajoutez des effets (comportements et filtres) à une couche, 
la palette est mise à jour en fonction de l’effet le plus récemment ajouté. Le nom 
d’une palette apparaît dans sa barre de titre. Pour passer d’une palette à la suivante, 
appuyez de manière répétée sur D. Pour revenir à la précédente, appuyez sur Maj + D. 
Les palettes se suivent selon l’ordre d’application des effets.
Pour accéder directement à une palette particulière, cliquez sur le triangle d’affichage 
en regard de son nom, puis choisissez un élément dans la liste.Chapitre 7 Utilisation de texte 627
Utilisation de la zone de Preview des polices dans la Bibliothèque
La Bibliothèque de Motion comporte la catégorie Polices ainsi qu’une zone de Preview 
qui servent à prévisualiser les polices ou à changer la police d’un texte.
Pour en savoir plus sur l’aperçu et le changement de polices dans l’Inspecteur Texte, 
consultez « Modification du format du texte » à la page 636. 
Aperçu des polices
Si vous sélectionnez une police dans la catégorie Polices de la Bibliothèque, un aperçu 
de cette police apparaît dans la zone de Preview de la Bibliothèque. 
Pour prévisualiser une police dans la Bibliothèque :
1 Dans la Bibliothèque, cliquez sur la catégorie Polices.
2 Cliquez sur la sous-catégorie de police à prévisualiser.
Remarque : la première sous-catégorie, Toutes les polices, contient toutes les polices 
des autres sous-catégories.
Si vous êtes en affichage Liste, les polices apparaissent sous forme de liste dans la pile. 
Si vous êtes en affichage Icônes, les polices apparaissent sous forme d’icônes dans 
la pile. Dans les images des pages qui suivent, l’affichage Icônes est sélectionné.
Présentation sous forme d’icônes
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3 Dans la pile, cliquez sur une vignette ou sur le nom d’une police.
La police apparaît dans la zone de Preview, accompagnée de son nom et de son style.
Changement de police
La Bibliothèque vous offre deux méthodes pour changer la police d’un texte dans 
le Canevas. La première consiste à faire glisser une police sur un objet texte dans 
le Canevas. Pour la seconde, sélectionnez un texte, choisissez un style dans la Bibliothèque, 
puis cliquez sur le bouton Appliquer dans la zone de Preview.
Zone de Preview
Sous-catégorie de polices
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Pour changer la police par glisser-déposer :
1 Dans la Bibliothèque, cliquez sur la catégorie Polices, puis sur la sous-catégorie de polices.
2 Faites glisser une police de la pile vers le texte dans le Canevas.
Au fil du déplacement de la police sur le texte, une vignette transparente de la police 
apparaît et le pointeur se transforme en pointeur vert d’ajout (+). Dès que vous relâchez 
le bouton de la souris, le texte est modifié selon la police sélectionnée.
Pour changer la police d’un texte avec le bouton Appliquer:
1 Sélectionnez le texte dont vous souhaitez changer la police.
2 Dans la Bibliothèque, cliquez sur la catégorie Polices, puis sur la sous-catégorie de polices.
3 Dans la pile, cliquez sur une police.
4 Dans la zone de Preview, cliquez sur Appliquer.
Le texte est modifié selon la police sélectionnée.
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Navigation dans la liste de polices
Pour localiser rapidement une police par son nom dans la pile de polices, vous pouvez 
saisir les premières lettres de son nom. 
Pour sélectionner une police en saisissant les premières lettres de son nom :
1 Cliquez sur un nom de police ou une vignette dans la pile de polices.
2 Tapez rapidement les deux premières lettres du nom de la police.
Remarque : si vous ne tapez pas rapidement la deuxième lettre du nom de la police, 
la sélection est réinitialisée et passe à la police dont le nom commence par la deuxième 
lettre tapée.
Pour parcourir les polices du navigateur par ordre alphabétique :
m Déplacez vers le haut ou vers le bas la barre de défilement située du côté droit 
de la pile pour parcourir les polices. 
Utilisation des outils Texte
Comme précédemment indiqué, le texte devient une couche de texte dès sa création. 
Vous disposez de deux méthodes pour modifier une couche de texte :
Â Comme toute autre couche dans Motion, le texte peut être modifié à l’aide des paramètres affichés sous l’onglet Propriétés de l’Inspecteur ou des commandes à l’écran.
Â Pour modifier les caractères du texte, utilisez les paramètres affichés sous l’onglet 
Texte de l’Inspecteur ou dans la palette.
Cette rubrique est consacrée aux outils servant à créer et modifier du texte. Les outils 
d’interface suivants servent à modifier du texte dans Motion :
Â Barre d’outils
Â Palettes Texte
Â Inspecteur Texte
Remarque : si vous avez sélectionné du texte grâce à l’outil de sélection par défaut, 
vous pouvez utiliser les commandes à l’écran standard pour déplacer et animer 
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Outil Texte et barre d’outils
L’outil Texte est situé dans la barre d’outils au-dessus du Canevas dans le groupe Créer.
Remarque : pour personnaliser la présentation de la barre d’outils, appuyez sur la touche 
Contrôle et cliquez dans la zone de la barre d’outils, puis choisissez Personnaliser la barre 
d’outils dans le menu contextuel. Pour en savoir plus sur les outils et la barre d’outils, 
voir « Barre d’outils » à la page 32.
Outil Texte : utilisez cet outil pour créer du texte. Cliquez sur l’outil Texte, puis cliquez 
dans le Canevas et commencez à taper. Pour sélectionner des caractères, cliquez sur 
l’outil Texte, puis faites-le glisser sur le texte.
Outil Sélectionner/Transformer : utilisez cet outil pour sélectionner et transformer 
du texte. Après la création d’un texte, cliquez sur l’outil Sélectionner/Transformer 
(ou appuyez sur Échap) pour le sélectionner. Pour sélectionner un texte existant, 
cliquez sur l’outil Sélectionner/Transformer, puis sur le texte.
Remarque : lorsque l’outil Sélectionner/Transformer est sélectionné, double-cliquez 
sur un texte pour activer automatiquement le mode de modification de texte.
Ajout de texte avec l’outil Texte
Pour ajouter du texte à un projet, vous devez utiliser l’outil Texte.
Pour ajouter du texte à votre projet, procédez de l’une des manières suivantes :
m Cliquez sur l’outil Texte (ou appuyez sur la touche T), puis dans le Canevas et commencez 
à taper.
m Cliquez sur l’outil Texte, puis faites glisser le pointeur dans le Canevas pour dessiner 
une marge personnalisée. Quand la marge est tracée, relâchez le bouton de la souris 
et commencez à taper.
Une fois qu’une marge est créée et que le texte est tapé, vous pouvez régler la taille 
de la marge sans modifier l’échelle du texte.
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Pour régler la taille de la marge sans mettre le texte à l’échelle, procédez de 
l’une des manières suivantes :
m Sélectionnez l’outil Texte, puis faites glisser l’une des poignées d’échelle du cadre 
de sélection du texte.
m Dans l’Inspecteur Texte, cliquez dans la sous-fenêtre Présentation et réglez les valeurs 
des marges gauche, droite, supérieure et inférieure.
Avec l’outil Texte, faites glisser 
une poignée d’échelle du cadre 
de sélection.
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Pour sélectionner des caractères, procédez de l’une des manières suivantes :
m Sélectionnez l’outil Texte, puis faites glisser le pointeur sur texte que vous souhaitez 
sélectionner.
m Cliquez entre deux caractères, appuyez sur la touche Maj, puis sur la touche Flèche 
droite pour sélectionner les caractères situés à droite du point d’insertion ou sur Flèche 
gauche pour sélectionner les caractères situés à gauche.
m Sélectionnez l’outil Sélectionner/Transformer, puis double-cliquez sur le texte.
Pour déplacer le pointeur entre les mots :
m Appuyez simultanément sur les touches Option + Flèche droite pour avancer le pointeur 
entre les deux mots suivants ou sur Option + Flèche gauche pour reculer le curseur 
entre les deux mots précédents.
Pour supprimer un mot entier :
m Placez le pointeur à la fin du mot à supprimer, puis appuyez simultanément sur 
les touches Option + Suppr.
Ajout de texte avec l’éditeur de texte
Après avoir ajouté une couche de texte vierge à votre projet (en cliquant sur l’outil 
Texte dans le Canevas), vous avez la possibilité de saisir et modifier du texte dans 
l’éditeur de texte, plutôt que dans le Canevas. L’éditeur de texte est utile quand 
vous manipulez de grandes quantités de texte.
Pour saisir du texte dans l’éditeur de texte :
1 Cliquez sur l’outil Texte (ou appuyez sur la touche T), puis dans le Canevas afin de créer 
une couche de texte vierge.
2 Dans l’Inspecteur Texte, cliquez dans la fenêtre Format.634 Chapitre 7 Utilisation de texte
3 Cliquez dans l’éditeur de texte et commencez à taper.
Remarque : comme la méthode de présentation du texte par défaut est Type, aucune 
marge n’est définie quand vous saisissez du texte dans l’éditeur de texte. Le texte continue 
donc sur une seule ligne tant que vous n’introduisez pas manuellement un saut de ligne. 
Pour en savoir plus sur la présentation du texte, consultez « Modification de la présentation du texte » à la page 682.
Vous pouvez aussi modifier un texte existant dans l’éditeur de texte, voire utiliser 
la fonction de vérification de l’orthographe de Mac OS X. 
Pour modifier du texte avec l’éditeur de texte :
1 Sélectionnez le texte à modifier.
Le texte sélectionné apparaît dans l’éditeur de texte.
2 Effectuez vos modifications dans l’éditeur de texte.
Les modifications sont immédiatement reflétées dans le Canevas.
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Pour utiliser la fonction de vérification de l’orthographe dans l’éditeur de texte, 
procédez de l’une des manières suivantes :
m Cliquez dans l’éditeur de texte, puis choisissez une option dans le sous-menu Édition > 
Orthographe.
m Cliquez dans l’éditeur de texte tout en maintenant la touche Contrôle enfoncée, 
puis choisissez un élément dans le menu contextuel.
Remarque : la fonction de vérification de l’orthographe n’est pas disponible quand 
vous manipulez du texte dans le Canevas.
Modification de texte dans l’Inspecteur
Toutes les commandes de texte sont situées sous l’onglet Texte de l’Inspecteur. L’onglet 
Texte est divisé en trois fenêtres : Format, Style et Présentation. La fenêtre Format contient 
des fonctions de texte essentielles, comme la police, la taille et le suivi. Les caractéristiques 
du texte, comme la face, le contour et le flou, sont contrôlées par la fenêtre Style. Quant 
à la fenêtre Présentation, elle contient les commandes de disposition du texte, comme 
les marges, la justification et le positionnement du texte sur une trajectoire.
Comme pour tous les paramètres dans Motion, si un paramètre peut être animé, 
l’icône du menu Animation apparaît en regard de ce paramètre dans l’Inspecteur. 
Cliquez 
pour afficher la 
fenêtre 
Format.
Cliquez 
pour afficher la 
fenêtre 
Style.
Cliquez pour 
afficher 
la fenêtre 
Présentation.
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Pour restaurer les réglages par défaut d’un paramètre (y compris supprimer les images 
clés), cliquez sur l’icône du menu Animation, puis choisissez Réinitialiser le paramètre 
dans le menu local.
Pour réinitialiser un groupe de paramètres, comme les commandes Face d’un texte ou 
les commandes Séquence d’un comportement de texte, cliquez sur le bouton Réinitialiser 
dans l’Inspecteur. Pour réinitialiser un seul paramètre d’un groupe, cliquez sur le menu 
Animation, puis choisissez Réinitialiser le paramètre.
Modification du format du texte
La fenêtre Format contient les commandes de texte essentielles, comme la police, 
le style, la taille, le crénage et la rotation des caractères. De nombreux paramètres 
de format peuvent être animés (avec des images clés).
Bouton 
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Pour afficher la fenêtre Format:
m Dans l’Inspecteur, cliquez sur l’onglet Texte, puis sur le bouton Format.
Commandes Format du texte
Cette rubrique décrit les paramètres de format du texte. Parmi les paramètres de 
format suivants, Nom de police, Style, Taille et Suivi apparaissent également dans 
la palette Texte.
Police : ce paramètre offre deux méthodes de filtrage et de sélection des polices.
Â Faites un choix dans le menu local (défini par défaut sur Polices système) pour filtrer 
les polices à afficher dans les listes Collections et Nom de police (voir ci-après). 
Vous pouvez choisir d’afficher les polices système ou LiveFonts (LiveType).
Â Cliquez sur Parcourir pour afficher le panneau Police Mac OS X.638 Chapitre 7 Utilisation de texte
Collections : affiche les collections de polices disponibles, en fonction du paramètre 
Police sélectionné. 
Nom de police : détermine la police appliquée au texte (le jeu de caractères, de lettres 
et de symboles d’une seule police).
Pour prévisualiser les différentes polices d’un texte dans le Canevas :
1 Sélectionnez le texte.
2 Dans la fenêtre Format de l’Inspecteur Texte, cliquez sur la flèche de la liste Nom de police.
La liste Nom de police s’affiche.
3 Faites glisser le pointeur vers le haut ou le bas de la liste des polices afin de prévisualiser 
les polices.
Pendant que vous parcourez la liste des polices, le texte du Canevas change en fonction 
de la police sélectionnée à ce moment-là.
4 Une fois la police choisie, relâchez le bouton de la souris. 
Remarque : vous pouvez aussi faire défiler la liste des polices vers le haut ou le bas via 
la barre de défilement ou la roulette d’une souris à trois boutons.
Style : définit le style, tel que Gras ou Condensé, etc. Les styles disponibles dépendent 
de la police sélectionnée.
Flèche de la liste déroulante 
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Taille : détermine la taille du texte. Vous pouvez saisir une valeur dans le champ 
de valeur ou utiliser le curseur. Pour changer la taille de la police, déplacez le curseur 
Taille vers la gauche ou la droite. La valeur Taille affichée dans la palette et l’Inspecteur 
est limitée à 288 points. Pour obtenir une taille de texte supérieure, tapez une valeur 
dans le champ Taille.
Remarque : vous pouvez aussi dimensionner le texte dans le Canevas à l’aide des commandes à l’écran. Toutefois, ce redimensionnement traite le texte comme une couche et 
se fait indépendamment du réglage de la taille en points dans les commandes Format. 
Suivi : détermine l’espacement entre les caractères du texte. Le suivi applique une 
valeur uniforme entre chaque caractère.
Crénage : règle l’espacement entre certains caractères du texte.
Pour appliquer un crénage particulier entre certains caractères d’un texte :
1 Cliquez sur l’outil Texte (ou appuyez sur la touche T).
2 Dans le Canevas, positionnez le point d’insertion (appuyez sur le bouton de la souris) 
entre les caractères que vous souhaitez créner, puis procédez de l’une des manières 
suivantes : 
Â Utilisez le curseur ou le champ de valeur Crénage pour définir une valeur de crénage 
spécifique.
Â Appuyez sur Contrôle + Flèche droite pour augmenter l’espacement entre les caractères 
par incréments d’un pixel.
Â Appuyez sur Contrôle + Flèche gauche pour réduire l’espacement entre les caractères 
par incréments d’un pixel.
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Pour déplacer le point d’insertion dans un texte :
m Utilisez les touches Flèche droite et Flèche gauche pour déplacer le point d’insertion 
entre des caractères adjacents.
m Pour atteindre le début d’une ligne de texte, appuyez sur Commande + Flèche gauche.
m Pour atteindre la fin d’une ligne de texte, appuyez sur Commande + Flèche droite.
m Pour passer au début du mot, appuyez sur Option + Flèche gauche.
m Pour passer à la fin du mot, appuyez sur Option + Flèche droite.
m Pour déplacer le point d’insertion dans un texte de plusieurs lignes (au sein d’une seule 
couche de texte), utilisez les touches Flèche vers le haut et Flèche vers le bas.
Ligne standard : règle la ligne standard des caractères du texte. La ligne standard est 
une « ligne » horizontale sur laquelle le bas des caractères est aligné.
Talus : simule le style italique en ajoutant une valeur d’inclinaison aux caractères 
du texte.
Échelle : dimensionne proportionnellement les caractères du texte, selon l’axe X ou Y. 
Pour une mise à l’échelle des caractères selon l’axe X ou Y uniquement, cliquez sur 
le triangle d’affichage pour saisir des valeurs distinctes de mise à l’échelle X ou Y. Sur 
l’illustration suivante, l’échelle X du texte est réglée sur 50 % et son échelle Y sur 100 %.
Décalage : décale le texte de sa position d’origine (point d’ancrage). Saisissez une valeur 
dans le curseur de gauche pour décaler le texte selon l’axe X et dans le curseur de droite 
pour décaler le texte selon l’axe Y. Cliquez sur le triangle d’affichage pour accéder aux 
valeurs des positions X, Y et Z.
Rotation : faites tourner le cadran ou saisissez une valeur dans le curseur pour faire 
pivoter les caractères du texte selon l’axe Z. Cliquez sur le triangle d’affichage pour 
accéder à des commandes de rotation selon les axes X, Y et Z distinctes, ainsi qu’au 
menu local Animer.
Â Animer : ce menu local vous permet de modifier l’interpolation des canaux de 
rotation 3D animés. Par défaut, ce paramètre est réglé sur Utiliser la rotation.
Remarque : pour que les options du paramètre Animer aient le moindre effet, 
le paramètre Rotation doit être animé avec des images clés.
Triangle d’affichage
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Â Utiliser la rotation : méthode d’interpolation par défaut. Les caractères du texte 
pivotent de leur rotation de départ vers leur rotation finale. Selon l’animation, 
ces caractères risquent de subir diverses torsions avant d’atteindre leur orientation 
finale (la dernière valeur d’image clé). Par exemple, si les paramètres Rotation X, Y 
et Z sont animés dans un projet de 0 à 180 degrés, les caractères du texte pivotent 
sur tous les axes avant d’atteindre leur orientation finale.
Â Utiliser l’orientation : cette méthode d’interpolation est plus lisse, mais elle n’autorise 
pas de multiples révolutions. Elle applique une interpolation entre l’orientation 
de départ des caractères du texte (première image clé) et leur orientation finale 
(deuxième image clé).
Pour en savoir plus sur le paramètre Animer, voir « Paramètres disponibles dans 
l’onglet Propriétés » à la page 312.
Espacement constant : si cette case est cochée, un espacement fixe est appliqué 
entre chaque caractère du texte.
Tout en majuscules : cette case permet d’afficher tous les caractères du texte 
en majuscules.
Taille Tout en majuscules : si la case Tout en majuscules est cochée, ce curseur définit 
la taille des caractères en majuscules (en pourcentage par rapport à la taille de la police).
Texte : permet de saisir directement dans l’éditeur de texte (la zone ombrée la plus 
sombre) pour ajouter et modifier du texte dans l’Inspecteur. Pour en savoir plus, 
voir « Ajout de texte avec l’éditeur de texte » à la page 633.
Éditer vers FCP : lorsque vous utilisez un projet Motion comme modèle dans 
Final Cut Pro, cochez cette case afin d’autoriser la modification de certains paramètres 
de texte dans Final Cut Pro. Les paramètres modifiables sont alors les suivants :
Â Chaîne de texte (il est possible de modifier les caractères du texte)
Â Taille du texte
Â Suivi du texte
Modification du style de texte
Utilisez la fenêtre Style pour spécifier le remplissage du texte ainsi que régler son opacité 
et son adoucissement. Un texte peut prendre la forme d’une couleur unie, d’une image 
ou d’un dégradé de couleur. La fenêtre Style vous permet également d’appliquer 
des contours, des éclats et des ombres portées à du texte. La plupart des paramètres 
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Un ensemble de styles de texte prédéfinis est disponible dans la Bibliothèque de Motion. 
Les styles de texte sont en fait des paramètres de style modifiés qui donnent un aspect 
spécifique au texte, comme un éclat et un dégradé rouge, et qui sont appliqués de 
la même manière que les comportements et les filtres. Vous pouvez créer des styles 
de texte personnalisés et les enregistrer dans la Bibliothèque. Pour en savoir plus, 
voir « Utilisation et création de styles de texte » à la page 674.
Pour afficher la fenêtre Style :
m Dans l’Inspecteur, cliquez sur l’onglet Texte, puis sur le bouton Style. 
La fenêtre Style comporte quatre groupes principaux de commandes : Face, Contour, 
Éclat et Ombre portée. Vous pouvez activer ou désactiver tous les styles d’une couche 
de texte. Par défaut, les paramètres Contour, Éclat et Ombre portée sont désactivés.
Commandes Face
Utilisez les commandes de texte Face pour spécifier si le texte est une couleur unie, 
un dégradé de couleur ou une texture. La rubrique suivante décrit les paramètres 
Face. Presque tous les paramètres Face peuvent être animés.
Face : active ou désactive les paramètres de face du texte (remplissage, couleur, 
opacité et flou). La face est activée par défaut.
Remplir avec : cliquez sur ce menu local pour sélectionner le remplissage du texte. 
Vous avez le choix entre : Couleur, Dégradé ou Texture.
Couleur : détermine la couleur de remplissage du texte. Cliquez sur le triangle d’affichage 
pour régler individuellement les canaux de couleur Rouge, Vert et Bleu du texte.
Opacité : définit l’opacité du texte, quelle que soit l’option de remplissage sélectionnée 
(Couleur, Dégradé ou Texture).
Flou : détermine l’adoucissement du texte, quelle que soit l’option de remplissage 
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Changement de la couleur du texte
Vous pouvez changer la couleur d’un texte par le biais de la fenêtre Couleurs, du cadre 
de couleur affiché par la palette Texte ou du cadre de couleur présent dans la fenêtre 
Style de l’Inspecteur Texte.
Remarque : pour régler individuellement les canaux de couleur, vous devez passer 
par la fenêtre Style l’Inspecteur Texte.
Pour définir la couleur du texte dans la palette :
1 Sélectionnez le texte.
2 Si la palette n’apparaît pas, appuyez sur F7 (ou sur D).
3 Cliquez dans le cadre de couleur, puis utilisez la fenêtre Couleurs pour définir la couleur 
du texte.
Remarque : il existe plusieurs méthodes pour choisir une couleur à l’aide du paramètre 
Couleur. Pour en obtenir la liste, consultez l’étape 5 de la rubrique suivante, qui décrit 
la sélection d’une couleur dans l’Inspecteur.
Le texte est mis à jour de façon dynamique dès que vous sélectionnez votre couleur. 
Remarque : pour sélectionner une couleur dans le Canevas (ou un élément quelconque 
du bureau), cliquez sur le sélecteur de couleur dans la fenêtre Couleurs, placez le sélecteur 
sur la couleur que vous voulez sélectionner, puis cliquez. 
Pour définir la couleur du texte dans l’Inspecteur :
1 Sélectionnez le texte.
2 Dans l’Inspecteur (accessible en appuyant sur les touches Commande + 3), cliquez sur 
l’onglet Texte.
3 Cliquez sur Style.
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4 Dans le menu local « Remplir avec », assurez-vous que l’option Couleur est sélectionnée.
5 Procédez de l’une des manières suivantes :
Â Cliquez dans le cadre de couleur, puis utilisez la fenêtre Couleurs pour définir 
la couleur du texte.
Â Cliquez sur la flèche située à droite du cadre de couleur (ou cliquez sur le cadre tout 
en maintenant la touche Contrôle enfoncée), puis déplacez le pointeur dans la palette 
de couleurs locale afin de sélectionner une couleur. Glissez vers le bas de la palette 
pour définir la couleur en niveaux de gris. 
Â Cliquez sur l’outil Pipette situé à droite du cadre de couleur, puis cliquez sur 
une couleur dans le Canevas.
Â Dans l’Inspecteur, cliquez sur le triangle d’affichage en regard de Couleur pour afficher 
les paramètres des canaux, puis utilisez les curseurs ou les champs pour ajuster chaque 
canal de couleur.
Remarque : vous avez la possibilité d’animer les couleurs des textes.
Cadre de couleur
Cliquez ici pour sélectionner une couleur en niveaux de gris
Affiche la couleur originale
Affiche la nouvelle couleur
Le triangle d’affichage
développé affiche
les canaux de couleur.Chapitre 7 Utilisation de texte 645
Application d’un dégradé à un texte
Vous pouvez appliquer un remplissage dégradé à un texte dans l’Inspecteur. 
Le dégradé peut être personnalisé et animé à l’aide de l’éditeur de dégradé.
Remarque : les commandes de dégradé disponibles pour les textes sont quasiment 
identiques aux commandes de dégradé pour les formes, les particules et les réplicateurs, 
à quelques paramètres près. Par exemple, les commandes de dégradé de texte incluent 
un cadran servant à spécifier la direction d’un dégradé linéaire. Les commandes de dégradé 
de forme incluent un réglage de début et de fin pour spécifier également la direction 
d’un dégradé linéaire. Pour en savoir plus sur l’utilisation de dégradés et de formes, 
voir « Utilisation des formes et des masques » à la page 1071.
Outre l’application d’un style de texte prédéfini enregistré dans la Bibliothèque, vous 
avez la possibilité d’appliquer à des textes des dégradés prédéfinis depuis la Bibliothè-
que. Les dégradés prédéfinis sont situés dans la catégorie Dégradés de la Bibliothèque. 
Vous pouvez enregistrer dans la Bibliothèque tout dégradé appliqué à un texte, afin de 
le réutiliser dans des projets en cours ou futurs.
Pour appliquer un dégradé à un texte :
1 Sélectionnez le texte.
2 Dans l’Inspecteur (accessible en appuyant sur les touches Commande + 3), cliquez sur 
l’onglet Texte.
3 Cliquez sur Style.
4 Dans le menu local « Remplir avec », choisissez Dégradé.
Dans l’Inspecteur, les commandes Couleur sont remplacées par la couleur de dégradé. 
Le dégradé par défaut est rouge et bleu. 
Réglez « Remplir avec » sur Dégradé.646 Chapitre 7 Utilisation de texte
Dans le Canevas, le dégradé par défaut est appliqué au texte sélectionné. 
Application d’un dégradé prédéfini à un texte
Vous disposez de deux méthodes pour appliquer à un texte un dégradé prédéfini 
(enregistré) depuis la Bibliothèque. La première méthode consiste à utiliser le menu 
local Préréglage de dégradé dans l’Inspecteur Texte. Pour la seconde, faites glisser 
un dégradé de la Bibliothèque sur le texte.
Pour appliquer un dégradé prédéfini dans l’Inspecteur Texte :
1 Vérifiez qu’un dégradé est appliqué au texte auquel vous souhaitez attribuer 
un dégradé prédéfini.
2 Choisissez un préréglage dans le menu local Préréglage de dégradé.
Menu local Préréglage 
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Le dégradé sélectionné est appliqué au texte.
Pour appliquer un dégradé prédéfini à partir de la Bibliothèque :
1 Dans la Bibliothèque, cliquez sur la catégorie Dégradés.
2 Dans la pile, sélectionnez un dégradé.
Un aperçu du dégradé sélectionné s’affiche dans la zone d’aperçu.648 Chapitre 7 Utilisation de texte
3 Procédez de l’une des manières suivantes :
Â Faites glisser le dégradé sur le texte dans le Canevas, l’onglet Couches ou la Timeline.
Â Assurez-vous que le texte est sélectionné, puis cliquez sur Appliquer dans la zone 
de Preview.
Dès qu’un dégradé prédéfini est appliqué à un texte, il peut être modifié à l’aide 
de l’éditeur de dégradé.
Utilisation de l’éditeur de dégradé
L’éditeur de dégradé vous sert à changer la couleur, la position, le nombre de couleurs, 
l’opacité, la direction et l’interpolation d’un dégradé. La couleur et l’opacité d’un dégradé 
peuvent être animées.
Cette rubrique décrit l’éditeur de dégradé disponible dans la fenêtre Style de 
l’Inspecteur Texte.
Commandes graphiques : trois barres qui vous permettent de régler la couleur, l’opacité 
et l’étalement d’un dégradé. Chacune de ces commandes graphiques active des commandes supplémentaires dans l’éditeur de dégradé, notamment les curseurs Couleur, 
Opacité et Emplacement.
Couleur : cadre de couleur qui définit la couleur de la balise de couleur sélectionnée. 
Opacité : curseur qui détermine la transparence de la balise d’opacité sélectionnée 
(dans les commandes graphiques ci-dessus). Les balises d’opacité permettent de contrôler 
l’opacité/la transparence du dégradé. Vous pouvez en ajouter plusieurs pour créer 
un dégradé affichant différents niveaux de transparence. Par défaut, l’opacité d’un 
dégradé appliqué à du texte est réglée sur 100 %.
Remarque : il existe également un paramètre Opacité (en dessous du paramètre Angle) 
qui contrôle l’opacité de l’ensemble du dégradé.
Interpolation : fixe l’interpolation de la balise de couleur sélectionnée sur Constante, 
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Â Constante : répartit uniformément la couleur de gauche à droite du dégradé, depuis 
la balise de couleur ou d’opacité. Par exemple, si la balise de couleur de gauche comporte trois couleurs et que l’interpolation du dégradé de gauche à droite est réglée 
sur Constante, le dégradé est uni entre la balise de gauche et la balise centrale.
Â Linéaire : répartit uniformément l’opacité ou la couleur entre les balises.
Â En continu : l’opacité ou la couleur change graduellement entre les balises de couleur 
ou d’opacité.
Emplacement : détermine l’emplacement de la balise de couleur ou d’opacité du dégradé 
sélectionné ou commande l’étalement.
Type : ce menu local vous permet d’opter pour un dégradé linéaire ou radial.
Â Linéaire : crée un dégradé linéaire.
Â Radial : crée un dégradé radial.
Angle : disponible si vous avez choisi Linéaire dans le menu local Type, ce cadran/
curseur vous permet de modifier l’angle du dégradé.
Commandes supplémentaires ayant un impact sur le remplissage des dégradés
Bien qu’elles ne soient pas intégrées à l’éditeur de dégradé, deux commandes supplé-
mentaires situées dans le groupe de paramètres Face vous permettent d’ajuster plus 
précisément un dégradé de texte.
Opacité : ce curseur permet de déterminer l’opacité du dégradé dans son ensemble. 
Cette commande est différente des commandes d’opacité de l’éditeur de dégradé, 
qui sont responsables de l’opacité à l’intérieur du dégradé.
Flou : utilisez ce curseur ou le curseur de valeur pour appliquer un flou à l’ensemble 
du dégradé. Le flou n’est jamais appliqué sur la base des différentes balises.
Important : les rubriques suivantes partent du principe que vous avez sélectionné un texte 
et choisi Dégradé dans le menu local Remplir avec affiché parmi les paramètres Face.650 Chapitre 7 Utilisation de texte
Pour changer les couleurs du dégradé :
1 Cliquez sur le triangle d’affichage Dégradé pour afficher l’éditeur de dégradé.
2 Pour modifier la couleur d’une balise de couleur, procédez de l’une des manières suivantes :
Â Double-cliquez sur une balise de couleur.
La fenêtre Couleurs apparaît. Utilisez-la pour définir une nouvelle couleur pour la balise.
Â Cliquez sur une balise de couleur pour activer les commandes Couleur de la couleur 
sélectionnée, puis cliquez sur le cadre de couleur. La fenêtre Couleurs apparaît.
Triangle d’affichage
Dégradé
Commandes de l’éditeur de dégradé
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Â Cliquez sur une balise de couleur, puis utilisez les différents curseurs des canaux 
Rouge, Vert ou Bleu.
Â Cliquez sur une balise de couleur, puis sur la flèche située à côté du cadre de couleur 
pour afficher la palette de couleurs locale. Cliquez dans la palette pour sélectionner 
une nouvelle couleur. Vous pouvez également cliquez dans le bas de la palette pour 
régler la balise sur une couleur en niveaux de gris.
Â Cliquez sur une balise de couleur, puis sur le cadre de couleur tout en maintenant 
la touche Contrôle enfoncée pour afficher la palette de couleurs locale.
Â Cliquez sur une balise de couleur, sélectionnez sur l’outil Pipette, puis cliquez sur 
une couleur dans le Canevas.
La balise de couleur bleu foncé est 
sélectionnée.
Cliquez ici pour sélectionner une couleur en niveaux de gris
Affiche la couleur originale
Affiche la nouvelle couleur652 Chapitre 7 Utilisation de texte
Pour repositionner une balise de couleur ou d’opacité :
1 Cliquez sur la balise de couleur ou d’opacité que vous souhaitez déplacer.
2 Procédez de l’une des manières suivantes :
Â Faites glisser la balise vers la gauche ou la droite.
Â Dans le paramètre Emplacement, utilisez le curseur ou le champ pour saisir une 
valeur spécifique. Les valeurs de 100 % et 0 % correspondent respectivement aux 
positions totalement à droite et à gauche du dégradé.
Pour modifier l’étalement de la couleur ou de l’opacité d’un dégradé :
m Faites glisser le petit triangle (la commande d’étalement) situé entre les balises de 
couleur ou d’opacité afin de changer l’emplacement de l’étalement. Plus ce triangle 
est proche d’une balise, plus l’étalement de la couleur ou de l’opacité est accentué.
Le paramètre Emplacement est également mis à jour lorsque vous déplacez la commande 
d’étalement, indiquant sa position sur le dégradé.
Pour modifier l’interpolation d’une balise de couleur ou d’opacité, procédez de 
l’une des manières suivantes :
m Cliquez sur une balise tout en maintenant la touche Contrôle enfoncée, puis choisissez 
Constante, Linéaire ou En continu dans le menu contextuel.
m Cliquez sur une balise, puis choisissez Constante, Linéaire ou En continu dans le menu 
local Interpolation.
Curseur Emplacement
Faites glisser la balise de
couleur pour changer la
position de la couleur
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Pour ajouter une balise de couleur à un dégradé :
m Pour ajouter une nouvelle balise de couleur, placez le pointeur sur la barre de couleurs 
inférieure à l’endroit où vous souhaitez ajouter la nouvelle couleur, puis cliquez.
Une nouvelle balise de couleur est ajoutée au dégradé. 
Remarque : bien que les couleurs et l’opacité d’un dégradé puissent être animées, 
il est impossible d’animer l’ensemble des balises de couleur et d’opacité.
Pour ajouter une balise d’opacité :
m Placez le pointeur sur la barre d’opacité où vous souhaitez ajouter la nouvelle balise, 
puis cliquez.
Une nouvelle balise d’opacité est ajoutée au dégradé.
Tant que la valeur n’est pas réglée, l’opacité du dégradé est égale à 100 %.
Pour dupliquer une balise de couleur ou d’opacité :
m Maintenez la touche Option enfoncée, puis faites glisser la balise vers sa nouvelle position.
Pour supprimer une balise de couleur ou d’opacité d’un dégradé :
m Faites glisser la balise en l’éloignant de la barre de dégradé.
Un petit bruit vous indique que la balise de couleur est supprimée.
Cliquez dans la barre de couleurs 
inférieure pour ajouter une couleur.
Nouvelle balise de couleur
Nouvelle balise 
d’opacité Barre d’opacité654 Chapitre 7 Utilisation de texte
Pour changer l’opacité d’une couleur de dégradé :
1 Cliquez sur une balise d’opacité.
Les commandes d’opacité sont activées.
2 Utilisez le curseur ou le curseur de valeur pour changer la valeur de la balise d’opacité 
sélectionnée.
Plus le pourcentage d’opacité est faible, plus la transparence est grande. Le degré 
d’opacité est appliqué à la zone d’un dégradé, pas à une balise de couleur spécifique.
La transparence du dégradé reflète les nouvelles valeurs d’opacité. Sur la figure suivante, 
l’opacité est définie sur 0 % du côté droit du dégradé (couleur rose pâle) : cette couleur 
disparaît donc en fondu. 
Modification de la direction et de la distribution des couleurs et de l’opacité
Vous pouvez rapidement inverser la direction ou distribuer uniformément les balises 
de couleur et d’opacité du dégradé.
Tag d’opacité sélectionné
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Pour inverser la couleur du dégradé ou la direction de l’opacité :
m Cliquez sur l’icône Inverser les balises située en regard de la barre d’opacité ou de couleur.
La balises sont alors inversées.
Pour répartir de façon homogène les balises de couleur ou d’opacité du dégradé :
m Cliquez sur l’icône Répartir les balises située en regard de la barre d’opacité ou de couleur.
Enregistrement de préréglages de dégradé
Comme avec les styles de texte, une fois que vous avez créé un dégradé, vous pouvez 
l’enregistrer dans la Bibliothèque.
Pour en savoir plus sur les styles de texte de la Bibliothèque, voir « Utilisation et création 
de styles de texte » à la page 674.
Pour enregistrer un dégradé dans la Bibliothèque :
1 Sélectionnez le texte avec le dégradé à enregistrer.
2 Choisissez Enregistrer le dégradé dans le menu local Préréglage de dégradé.
Icône Inverser les balises (opacité)
Icône Inverser les balises (couleur)
Icône Répartir les balises (opacité)
Icône Répartir les balises (couleur)
Menu local 
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3 Dans la zone de dialogue Enregistrer ce préréglage dans la Bibliothèque, tapez le nom 
du dégradé.
4 Cliquez sur Enregistrer.
Le dégradé personnalisé apparaît dans la catégorie Dégradés de la Bibliothèque. 
Les préréglages personnalisés sont identifiables dans la Bibliothèque à l’aide de 
la petite icône d’utilisateur qui apparaît en bas à droite de l’icône de dégradé de plus 
grande taille. Le nouveau dégradé apparaît également dans le menu local Préréglage 
de dégradé.
Dégradé personnalisé enregistré 
dans la BibliothèqueChapitre 7 Utilisation de texte 657
Comme les dégradés prédéfinis, un aperçu du dégradé apparaît dans la zone 
de prévisualisation quand le dégradé est sélectionné dans la pile.
Application de comportements Paramètre aux dégradés
Pour créer des effets de dégradé uniques, vous pouvez appliquer des comportements 
Paramètre aux paramètres de dégradé, tels que Opacité, Emplacement, Angle et Couleur. 
Cette opération est effectuée de la même façon que l’application d’un comportement 
Paramètre à n’importe quel autre paramètre dans Motion.
Dans l’exemple suivant, un comportement Rendre aléatoire est appliqué au paramètre 
de couleur RVB d’une couleur dans un dégradé à trois couleurs.
Pour appliquer un comportement de paramètre Rendre aléatoire à une couleur 
de dégradé :
1 Dans l’Inspecteur, sélectionnez une balise de couleur dans l’éditeur de dégradé.
2 Si les paramètres Couleur ne sont pas affichés, cliquez sur le triangle d’affichage Couleur.
3 Sélectionnez un canal de couleur tel que Rouge (la commande est ombrée lorsqu’elle 
est sélectionnée), cliquez sur le paramètre tout en maintenant la touche Contrôle 
enfoncée, puis choisissez Rendre aléatoire dans le menu contextuel.
Le paramètre Rendre aléatoire est appliqué à la balise de couleur. Ensuite, vous devez 
affecter les canaux de couleur auxquels vous souhaitez appliquer le comportement.
4 Dans la palette Rendre aléatoire ou l’Inspecteur, choisissez une option dans le menu local 
« Appliquer à » (Aller). Dans cet exemple, choisissez Styles > Style > Face > Dégradé > 
RVB > RVB2 (pour la deuxième balise de couleur du dégradé) > Couleur > Tout.
Remarque : si vous utilisiez une forme, vous choisiriez Objet > Remplissage > Dégradé > 
RVB > RVB2 (pour la deuxième balise de couleur) > Couleur > Tout.
Un élément RVB apparaît pour chaque balise de couleur du dégradé, comme un élément 
Alpha pour chaque balise d’opacité. Étant donné que le dégradé de cet exemple comporte trois couleurs, trois éléments RVB apparaissent (RVB1, RVB2 et RVB3). Les éléments 
sont numérotés de gauche à droite ; RVB1 est la couleur de dégradé la plus à gauche, 
RVB2 est la couleur du milieu et RVB3 celle la plus à droite. 658 Chapitre 7 Utilisation de texte
Les paramètres Décalage et Milieu apparaissent également dans le menu local au-dessus 
de l’élément Couleur. Décalage représente l’emplacement de la couleur dans le dégradé 
(le paramètre Emplacement) et Milieu représente l’étalement de la couleur entre deux 
balises (le petit triangle entre les balises de dégradé de couleur).
Remarque : le comportement Paramètre peut être appliqué à n’importe quel paramètre 
apparaissant dans le menu local « Appliquer à » (Aller).
5 Cliquez sur le bouton de lecture (ou appuyez sur la barre d’espace).
6 Dans les paramètres Rendre aléatoire, effectuez les opérations suivantes :
Â Augmentez le curseur Quantité sur 0,5 environ.
Â Réduisez le paramètre Fréquence à 5 environ, de sorte que les changements de couleur 
soient moins fréquents.
Â Affectez au paramètre Bruit la valeur 0, de sorte que les changements de couleur 
soient plus légers.
Lorsque la balise de couleur avec le comportement Paramètre appliqué est sélectionnée 
dans l’Inspecteur, l’icône Comportements apparaît en regard des paramètres du canal 
de couleur. Si le comportement Rendre aléatoire est uniquement appliqué au canal 
Rouge, l’icône Comportements apparaît seulement en regard du paramètre Rouge.
Utilisation d’une texture de remplissage
Vous pouvez vous servir d’une image, d’un film, d’une forme, d’une couche ou d’un groupe 
comme texture de remplissage d’un texte. Pour ce faire, utilisez l’option Texture proposée 
parmi les commandes Face de l’Inspecteur.
Les paramètres de texture respectent les filtres appliqués à l’image source, mais pas 
les transformations qui lui sont appliquées. Par exemple, si le filtre Éclat a été appliqué 
à l’image utilisée comme texture source, le même éclat apparaît dans la texture du texte. 
En revanche, si l’image utilisée comme texture source a été mise à l’échelle ou déplacée 
ou bien contient des comportements appliqués, le résultat des transformations n’apparaît 
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Pour appliquer une texture à un texte :
1 Sélectionnez le texte.
2 Dans l’Inspecteur, cliquez sur l’onglet Texte.
3 Cliquez sur Style.
4 Dans le menu local « Remplir avec », choisissez Texture.
Les commandes Couleur (ou Dégradé) laissent la place aux commandes Texture. 
5 Cliquez sur le triangle d’affichage Texture.
Par défaut, aucune texture n’est appliquée au texte.
6 Sous l’onglet Couches ou Média (de la sous-fenêtre Projet), cliquez sur l’image à utiliser 
comme texture, puis faites-la glisser dans le cadre d’image.
L’image apparaît dans le cadre et est appliquée au texte. Lorsque le remplissage du 
texte se fait à partir d’une image, la texture est appliquée à chaque caractère du texte. 
Pour en savoir plus sur l’application d’une texture en continu à tous les caractères d’un 
texte, voir « Différences entre l’application d’une texture aux caractères d’un texte 
et à l’ensemble d’un texte » à la page 664.
Cadre d’image660 Chapitre 7 Utilisation de texte
Important : quand vous sélectionnez une image à placer dans le cadre d’image, veillez 
à cliquer dessus et à la faire glisser en un seul mouvement. Si vous cliquez sur l’image 
et que vous relâchez le bouton de la souris, l’image est sélectionnée et son Inspecteur 
apparaît. Cela vaut aussi pour le cadre d’image pour les masques.
Pour remplacer une texture : 
1 Sélectionnez le texte, puis développez l’affichage des commandes Texture.
2 Sous l’onglet Couches ou Média, cliquez sur l’image à utiliser pour remplacer la texture, 
puis faites-la glisser dans le cadre d’image.
La nouvelle image apparaît dans le cadre et est appliquée au texte.
Remarque : si une image (ou un plan d’un film) utilisée comme source de texture 
est remplacée dans l’onglet Couches ou Média, la texture du texte est remplacée par 
la nouvelle image.
Pour supprimer une texture, procédez de l’une des manières suivantes :
m Cliquez sur le bouton Réinitialiser du paramètre Texture.
m Faites glisser l’image hors du cadre, puis relâchez le bouton de la souris. Un petit bruit 
indique la suppression.
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Modification d’une texture
Si vous vous servez d’une séquence d’images ou d’une séquence comme source 
de texture d’un texte, vous pouvez indiquer l’image de début de la texture ou choisir 
de figer une seule image pour la texture. Vous pouvez également ajuster la position 
d’une texture appliquée à un texte, de telle sorte qu’elle soit décalée par rapport au 
texte, sans être repositionnée dans votre projet. Si une image utilisée comme texture 
est coupée, vous pouvez spécifier le comportement des bords de la texture.
Image : faites glisser l’image à utiliser comme texture source dans le cadre d’image.
Conserver l’mage : quand vous utilisez un film ou une séquence d’images comme 
texture source, utilisez le curseur ou les champs de valeur pour spécifier l’image 
de début de la texture.
Conserver l’image : quand vous utilisez un film ou une séquence d’images comme 
texture source, activez l’option Conserver l’image pour geler l’image spécifiée dans 
le paramètre Image. L’image sélectionnée est alors utilisée comme texture pour 
la durée totale de la couche de texte.
Décalage : déplacez les curseurs ou saisissez une valeur dans les champs Décalage 
pour spécifier les valeurs X et Y de la position de la texture source (par rapport à 
la couche de texte).
Pour changer la position d’une texture :
m Dans les commandes Texture, procédez de l’une des manières suivantes :
Â Appuyez sur Commande et faites glisser le curseur dans le cadre d’image.
L’image se déplace dans le cadre. Dans le Canevas, elle apparaît décalée dans le texte.
Â Réglez les valeurs de décalage. Les curseurs de gauche et de droite représentent respectivement les valeurs de position X et Y. Cliquez sur le triangle d’affichage pour 
afficher les curseurs de valeur X et Y.
Mode de transition : utilisez ce menu local pour indiquer le traitement des bords de 
la texture quand cette dernière est décalée et apparaît coupée dans le texte, ou quand 
elle est trop petite pour remplir le texte auquel elle est appliquée.
Utilisez le curseur ou le champ de valeur 
pour définir une image de début.
Déplacez les curseurs ou saisissez des 
valeurs dans les champs correspondants 
pour repositionner la texture source.
Cliquez pour verrouiller
la source de la texture
sur l’image définie dans
le paramètre Image.
Choisissez un mode de transition 
dans ce menu local.662 Chapitre 7 Utilisation de texte
Â Aucune : comme pour le mode de transition par défaut, la texture reste transparente 
sous le bord de l’image source.
Â Répétition : comme dans le cas du comportement Mosaïque, la texture source 
est répétée sous le bord de l’image source.
Â Miroir : au-delà des limites de l’image source, la source de texture est réfléchie 
comme dans un miroir : dupliquée, affichée en mosaïque ou bien inversée 
pour couvrir la largeur et la hauteur totales du texte.
Animation d’une texture
Vous avez la possibilité de définir des images clés pour les valeurs de décalage de 
la texture source, afin de créer un élément en mouvement au sein de votre texte. 
Dans l’exemple suivant, une image d’un léopard étendu dans l’herbe est utilisée 
comme texture source pour le texte « léopard ».
Pour animer le décalage de la texture :
1 Appliquez une texture au texte. 
Pour en savoir plus sur l’application d’une texture à un texte, voir « Utilisation d’une 
texture de remplissage » à la page 658.
2 Atteignez l’image où vous souhaitez que l’animation de la texture commence.
3 Activez l’enregistrement (appuyez sur la touche A).
Remarque : gardez présent à l’esprit que, quand l’enregistrement est activé, une image 
clé est créée à chaque modification d’un objet dans votre projet.
Couche de texte d’origine avant l’application 
de la texture
Image utilisée comme texture source
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4 Pour positionner la texture, procédez de l’une des manières suivantes :
Â Appuyez sur Commande et faites glisser le curseur dans le cadre d’image.
Â Utilisez les curseurs ou les champs de valeur de décalage pour saisir une valeur 
de décalage.
L’image dans le texte se déplace, et une image clé est créée dans les paramètres 
Décalage.
5 Atteignez l’image suivante où vous souhaitez définir une image clé.
6 Déplacez la texture à la nouvelle position.
Couche de texte avec une texture appliquée
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7 Atteignez l’image 1 (ou l’image de début de votre animation) et lisez le plan.
Le décalage de la texture est animé.
8 Désactivez l’enregistrement.
Remarque : vous pouvez aussi utiliser le menu Animation dans l’Inspecteur pour définir 
manuellement des images clés sans activer l’enregistrement. Pour en savoir plus, 
voir « Images et clés et courbes » à la page 547. 
Différences entre l’application d’une texture aux caractères d’un texte 
et à l’ensemble d’un texte
Lorsque vous choisissez d’appliquer une image (ou une couche) à un texte comme 
texture, cette texture est appliquée à chacun des caractères du texte. Pour utiliser 
cette image comme texture continue sur l’ensemble du texte, vous devez utiliser 
le texte comme un masque.
Utilisation d’une couche avec des comportements et des filtres 
comme texture source
Lorsque vous choisissez la texture source d’un texte, vous pouvez opter pour n’importe 
quelle couche (image, film, séquence d’images, forme, réplicateur, système de particules, 
groupe ou autre couche de texte) à laquelle sont appliqués des comportements 
et des filtres. Si la couche comporte des filtres activés, leur résultat est visible dans 
la texture. En revanche, si la couche choisie a des comportements ou des transformations actifs, ils sont ignorés : seule l’image apparaît comme texture. Conformez-vous 
aux règles suivantes lorsque vous utilisez des couches comme sources de texture.
Si un filtre est appliqué à la couche utilisée comme texture source :
Â Pour utiliser une couche avec l’effet du filtre, suivez les étapes décrites dans 
« Utilisation d’une texture de remplissage » à la page 658.
Â Si la couche est une image ou une séquence d’images, vous pouvez l’utiliser 
sans l’effet des filtres en la faisant glisser de l’onglet Média (plutôt que de l’onglet 
Couches) dans le cadre Image de texture.
Â Pour utiliser une couche sans l’effet du filtre, faites-en une copie dans l’onglet 
Couches, supprimez les filtres appliqués, puis désactivez la couche. Vous pouvez 
ensuite la faire glisser de l’onglet Couches vers le cadre d’image.
Si un comportement ou une transformation (par exemple, Rotation) est appliqué 
à la couche utilisée comme texture source :
Â Suivez les étapes décrites dans « Utilisation d’une texture de remplissage » à la 
page 658. Les effets du comportement ou des transformations sont ignorés.Chapitre 7 Utilisation de texte 665
Pour utiliser du texte afin de masquer une image :
1 Sous l’onglet Couches ou dans le Canevas, sélectionnez la couche à utiliser comme texture.
2 Choisissez Objet > Ajouter un masque d’image (ou appuyez sur les touches 
Maj + Commande + M).
Une couche de masque d’image vierge est ajoutée à l’image.
3 Faites glisser le texte à utiliser comme masque vers l’un des emplacements suivants :
Â Le cadre Source de masque dans la palette Masque d’image.
Â La couche du masque d’image dans l’onglet Couches (déposez le texte sur la couche 
du masque d’image dans l’onglet Couches).
Â Le cadre d’image sous l’onglet Masque d’image de l’Inspecteur.
Image sélectionnée en vue d’être masquée par 
une couche de texte
Illustration fournie avec l’aimable autorisation 
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Le texte masque alors l’image.
Pour en savoir plus, voir « Utilisation des formes et des masques » à la page 1071.
Modification de l’opacité du texte
Dans la palette ou dans l’Inspecteur, utilisez le curseur d’opacité ou le champ de valeur 
pour régler l’opacité d’un texte.
Pour définir l’opacité du texte dans la palette :
1 Sélectionnez le texte.
2 Appuyez sur F7 (ou sur D) pour afficher la palette.
Les commandes d’opacité sont situées en haut.
3 Déplacez le curseur Opacité.
L’opacité du texte est actualisée de façon dynamique alors que vous déplacez le curseur.
Pour définir l’opacité dans l’Inspecteur :
1 Sélectionnez le texte.
2 Dans l’Inspecteur, cliquez sur l’onglet Texte.Chapitre 7 Utilisation de texte 667
3 Ouvrez la fenêtre Style.
4 Dans les commandes Face, déplacez le curseur Opacité ou saisissez une valeur 
d’opacité dans le champ.
Remarque : une couche de texte étant similaire à toute autre couche dans Motion, 
vous pouvez également régler son opacité dans l’onglet Propriétés. Les définitions de 
la valeur Opacité sous l’onglet Propriétés et dans la fenêtre Style sont des commandes 
distinctes dont les effets se multiplient. Autrement dit, si la valeur Opacité est définie 
sur 50 % sous l’onglet Propriétés, puis sur 50 % dans la fenêtre Style de texte, l’opacité 
du texte est au final de 25 %.
Modification de l’adoucissement du texte
Vous devez utiliser le paramètre Flou dans la fenêtre Style de l’Inspecteur Texte pour 
régler l’adoucissement d’un texte. 
Pour régler l’adoucissement dans l’Inspecteur:
1 Sélectionnez le texte.
2 Dans l’Inspecteur, cliquez sur l’onglet Texte.
3 Ouvrez la fenêtre Style.
4 Dans les commandes Face, déplacez le curseur Flou ou saisissez une valeur dans 
le champ correspondant.
L’adoucissement du texte est actualisé de façon dynamique alors que vous déplacez 
le curseur.
Paramètre Opacité
de l’onglet Propriétés
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Réinitialisation des commandes Face
Vous avez la possibilité de réinitialiser les paramètres d’origine relatifs au remplissage, 
à l’opacité et au flou d’un texte grâce à l’Inspecteur.
Pour réinitialiser les paramètres Face d’un texte :
Cliquez sur le bouton Réinitialiser situé sur la ligne de la case à cocher Face.
Commandes Contour d’un texte
Utilisez les commandes Contour dans la fenêtre Style pour créer des contours de texte. 
Vous pouvez changer le remplissage du contour, ainsi que son opacité, son adoucissement, sa largeur et l’ordre des couches. À l’exception du paramètre Ordre de couche, 
tous les paramètres de contour peuvent être animés.
Contour : case à cocher permettant d’activer ou de désactiver le contour du texte. 
Le paramètre Contour est désactivé par défaut.
Remplir avec : choisissez un élément dans ce menu local pour définir le remplissage 
du contour. Comme pour les commandes Face, vous pouvez définir le remplissage 
du contour sur Couleur, Dégradé ou Texture.
Couleur : cliquez dans le cadre de couleur pour sélectionner la couleur du contour. 
Cliquez sur le triangle d’affichage Couleur pour régler individuellement les canaux 
de couleur Rouge, Vert et Bleu.
Opacité : définit l’opacité du contour du texte.
Flou : définit l’adoucissement du contour du texte.
Largeur : détermine l’épaisseur du contour.
Ordre de couche : détermine si le contour est dessiné sur ou sous la face du texte.
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Ajout d’un contour de texte
Pour créer un contour de texte, activez le paramètre Contour dans la fenêtre Style 
de l’Inspecteur Texte.
Pour ajouter un contour à un texte :
1 Sélectionnez le texte.
2 Dans l’Inspecteur, cliquez sur l’onglet Texte.
3 Ouvrez la fenêtre Style.
4 Dans les commandes Contour, cochez la case Contour.
Par défaut, le contour est de couleur rouge et d’une largeur de 1 point.
Remarque : le contour d’un texte n’est visible que si ses paramètres Face sont désactivés.
Modification des contours de texte
Utilisez les commandes Contour pour adoucir l’opacité ou le flou d’un contour de texte, 
pour modifier la largeur d’un contour ou encore pour définir et modifier le remplissage 
d’un contour.
Pour changer la couleur d’un contour de texte :
m Cliquez dans le cadre de couleur, puis sélectionnez une couleur dans la fenêtre Couleurs.
Pour régler l’opacité d’un contour de texte :
m Utilisez le curseur ou le champ de valeur Opacité pour changer l’opacité du contour.
Pour régler le flou d’un contour de texte :
m Utilisez le curseur ou le champ de valeur Flou pour changer le flou du contour.
Pour changer la largeur d’un contour de texte :
m Utilisez le curseur ou le champ de valeur Largeur pour changer la largeur du contour.
Pour définir l’ordre des couches d’un contour de texte :
m Faites un choix dans le menu local Ordre de couche.
Â Choisissez Face inférieure pour placer le contour derrière la face du texte.
Â Choisissez Face supérieure pour placer le contour devant la face du texte.670 Chapitre 7 Utilisation de texte
Remarque : les options de remplissage des contours (couleur, dégradé et texture) sont 
identiques aux commandes des paramètres Face. Pour en savoir plus sur l’utilisation 
de ces commandes, consultez « Commandes Face » à la page 642.
Pour réinitialiser les paramètres Contour d’un texte :
m Cliquez sur le bouton Réinitialiser situé sur la ligne de la case à cocher Contour.
Commandes Éclat d’un texte
Utilisez les commandes Éclat pour créer un éclat à l’avant ou à l’arrière d’un texte. 
À l’exception du paramètre Ordre de couche, tous les paramètres d’éclat peuvent 
être animés.
Éclat : case à cocher permettant d’activer ou de désactiver l’effet d’éclat sur le texte. 
Le paramètre Éclat est désactivé par défaut.
Remplir avec : choisissez un élément dans ce menu local pour définir le remplissage 
de l’éclat. Comme pour les commandes Face et Contour, vous pouvez définir le remplissage de l’éclat sur Couleur, Dégradé ou Texture.
Couleur : détermine la couleur de l’effet d’éclat. Cliquez dans le cadre de couleur pour 
sélectionner la couleur de l’éclat. Cliquez sur le triangle d’affichage Couleur pour régler 
individuellement les canaux de couleur Rouge, Vert et Bleu.
Opacité : définit l’opacité de l’éclat du texte.
Flou : définit l’adoucissement de l’éclat du texte. 
Rayon : définit la circonférence de l’éclat.
Échelle : détermine la taille de l’éclat.
Décalage : décale l’éclat dans la position X ou Y.
Ordre de couche : détermine si l’éclat est dessiné sur ou sous la face du texte.Chapitre 7 Utilisation de texte 671
Ajout d’un éclat de texte
Pour créer un éclat de texte, activez le paramètre Éclat dans la fenêtre Style de 
l’Inspecteur Texte.
Pour ajouter un éclat à un texte :
1 Sélectionnez le texte.
2 Dans l’Inspecteur (accessible en appuyant sur les touches Commande + 3), 
cliquez sur l’onglet Texte.
3 Ouvrez la fenêtre Style.
4 Cochez la case Éclat.
Par défaut, l’éclat est jaune, ses paramètres Échelle et Opacité sont réglés sur 100 %, 
alors que sa valeur Rayon est définie sur 1.
Remarque : l’éclat d’un texte n’est visible que si ses paramètres Face (et tout autre 
paramètre actif) sont désactivés.
Modification de l’éclat d’un texte
Utilisez les commandes Éclat pour adoucir l’opacité ou le flou de l’éclat de texte, 
pour modifier sa taille ou encore pour définir et modifier son remplissage.
Pour changer la couleur de l’éclat :
m Cliquez dans le cadre de couleur, puis sélectionnez une couleur dans la fenêtre Couleurs.
Pour régler l’opacité de l’éclat :
m Utilisez le curseur ou le curseur de valeur Opacité pour changer l’opacité de l’éclat.
Pour régler le flou de l’éclat :
m Utilisez le curseur ou le champ de valeur Flou pour changer le flou de l’éclat.
Pour régler le rayon de l’éclat :
m Utilisez le curseur ou le champ de valeur Rayon pour régler le rayon de l’éclat.
Pour régler l’échelle de l’éclat :
m Utilisez le curseur ou le champ de valeur Échelle pour mettre l’éclat à l’échelle proportionnellement. Pour une mise à l’échelle selon l’axe X ou Y uniquement, cliquez sur 
le triangle d’affichage Échelle, puis ajustez le curseur X ou Y.672 Chapitre 7 Utilisation de texte
Pour régler la position de l’éclat :
m Utilisez les champs de valeur Décalage pour changer la position de l’éclat. Les curseurs 
de gauche et de droite représentent respectivement les axes X et Y. Pour afficher individuellement les champs de décalage X ou Y, cliquez sur le triangle d’affichage Décalage.
Pour définir l’ordre des couches de l’éclat :
m Choisissez un élément dans le menu local Ordre de couche.
Â Choisissez Face inférieure pour placer l’éclat derrière la face du texte.
Â Choisissez Face supérieure pour placer l’éclat devant la face du texte.
Remarque : les options de remplissage des éclats (couleur, dégradé et texture) sont 
identiques aux commandes des paramètres Face. Pour en savoir plus sur l’utilisation 
de ces commandes, consultez « Commandes Face » à la page 642.
Pour réinitialiser les paramètres Éclat d’un texte :
m Cliquez sur le bouton Réinitialiser situé sur la ligne de la case à cocher Éclat.
Commandes Ombre portée d’un texte
Utilisez les commandes Ombre portée pour créer une ombre portée sur un texte, ainsi 
que pour régler sa couleur, son opacité, son décalage par rapport à la couche de texte, 
son adoucissement et son angle. Tous les paramètres Ombre portée peuvent être animés.
Ombre portée : case à cocher permettant d’activer ou de désactiver l’effet d’ombre 
portée sur le texte. Le paramètre Ombre portée est désactivé par défaut.
Remarque : si la case Aplatir est cochée dans la fenêtre Présentation de l’Inspecteur 
Texte, l’onglet Propriétés affiche également des commandes permettant d’activer et de 
désactiver une ombre portée sur une couche de texte. Les commandes Ombre portée sous 
l’onglet Propriétés de l’Inspecteur sont indépendantes des commandes de l’Inspecteur 
Texte. L’activation du paramètre Ombre portée à ces deux emplacements ne fait 
qu’ajouter à l’ombre déjà appliquée.
Remplir avec : choisissez un élément dans ce menu local pour définir le remplissage 
de l’ombre. Comme pour les commandes Face, Contour et Éclat, vous pouvez définir 
le remplissage de l’ombre sur Couleur, Dégradé ou Texture.Chapitre 7 Utilisation de texte 673
Couleur : cliquez dans le cadre de couleur pour sélectionner la couleur de l’ombre. 
Cliquez sur le triangle d’affichage Couleur pour régler individuellement les canaux 
de couleur Rouge, Vert et Bleu.
Opacité : définit l’opacité de l’ombre du texte.
Flou : définit l’adoucissement de l’ombre du texte. 
Échelle : définit la taille de l’ombre.
Distance : définit le décalage de l’ombre appliquée au texte.
Angle : définit l’angle (ou la direction) de l’ombre portée.
Ajout d’une ombre portée
Pour créer une ombre portée de texte, activez le paramètre Ombre portée dans la fenêtre 
Style de l’Inspecteur Texte.
Pour ajouter une ombre portée :
1 Sélectionnez le texte.
2 Dans l’Inspecteur, cliquez sur l’onglet Texte.
3 Ouvrez la fenêtre Style.
4 Parmi les paramètres Ombre portée, cochez la case Ombre portée.
Par défaut, une ombre portée noire est appliquée au texte.
Réglage des paramètres Ombre portée
Utilisez les commandes Ombre portée pour changer la couleur ou l’opacité de l’ombre 
et pour régler son adoucissement. Vous pouvez également modifier la distance de 
décalage de l’ombre par rapport au texte et ajuster son angle.
Pour régler la couleur de l’ombre portée :
m Cliquez dans le cadre de couleur et utilisez la fenêtre Couleurs pour définir 
une nouvelle couleur.
Pour régler l’opacité de l’ombre portée :
m Dans le paramètre Opacité, déplacez le curseur ou utilisez le champ de valeur.674 Chapitre 7 Utilisation de texte
Pour régler l’adoucissement de l’ombre portée :
m Utilisez le curseur ou le champ de valeur Flou pour changer le flou de l’ombre.
Pour changer l’échelle de l’ombre portée :
m Utilisez le curseur ou le champ de valeur Échelle pour mettre l’ombre portée à l’échelle 
tout en respectant le rapport largeur-hauteur. Pour une mise à l’échelle selon l’axe X ou 
Y uniquement, cliquez sur le triangle d’affichage Échelle, puis ajustez le curseur X ou Y.
Pour modifier la distance de l’ombre par rapport au texte :
m Dans le paramètre Distance, déplacez le curseur ou utilisez le champ de valeur. La distance 
de décalage de l’ombre est exprimée en pixels.
Pour modifier l’angle de l’ombre par rapport au texte :
m Faites tourner le cadran Angle ou utilisez le champ de valeur.
Remarque : les options de remplissage des ombres portées (couleur, dégradé et texture) 
sont identiques aux commandes des paramètres Face.
Pour réinitialiser les paramètres Ombre portée d’un texte :
m Cliquez sur le bouton Réinitialiser situé sur la ligne de la case à cocher Ombre portée.
Utilisation et création de styles de texte
La Bibliothèque de Motion contient un jeu de styles de texte prédéfinis que vous pouvez 
facilement appliquer aux textes présents dans votre projet. Un style de texte est un groupe 
de paramètres de style qui ont été modifiés et enregistrés dans la Bibliothèque. 
Par exemple, le style de texte Eaux tropicales inclut un remplissage basé sur les couleurs 
dégradées d’un lagon tropical et un éclat pur coloré en bleu. Ce style est placé sur 
la face du texte, mis à l’échelle, puis décalé.
Vous pouvez aussi personnaliser et enregistrer votre propre style ou format de texte 
(voire les deux) dans la Bibliothèque. 
Style de texte Eaux tropicales appliqué à une 
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Application d’un style de texte
Vous disposez de deux méthodes pour appliquer un style à un texte. La première 
méthode consiste à sélectionner un style dans la Bibliothèque. L’avantage d’utiliser 
la Bibliothèque pour appliquer un style de texte est que vous avez la possibilité de 
prévisualiser le style avant de l’appliquer à votre texte. La seconde consiste à appliquer 
le style dans l’Inspecteur Texte, à l’aide du menu local Préréglage Style. Cette rubrique 
passe en revue ces deux méthodes.
Pour appliquer un style de texte à partir de la Bibliothèque :
1 Dans la Bibliothèque (accessible en appuyant sur les touches Commande + 2), 
sélectionnez la catégorie Styles de texte.
2 Sélectionnez un style dans la pile.676 Chapitre 7 Utilisation de texte
Un aperçu du style s’affiche dans la zone de Preview.
3 Procédez de l’une des manières suivantes :
Â Sélectionnez le texte auquel vous souhaitez appliquer le style, puis cliquez sur 
le bouton Appliquer dans la zone de Preview.
Â Faites glisser le style de la pile vers le texte dans le Canevas, l’onglet Couches 
ou la Timeline.
Le style est appliqué au texte sélectionné.Chapitre 7 Utilisation de texte 677
Pour appliquer un style de texte à partir de l’Inspecteur Texte : 
1 Sélectionnez le texte auquel vous souhaitez appliquer un style.
2 Dans la fenêtre Style de l’Inspecteur Texte, choisissez un élément dans le menu local 
Préréglage Style.
Le style est appliqué au texte sélectionné.
Réinitialisation du style d’un texte
Utilisez le bouton Réinitialiser situé dans l’Inspecteur pour restaurer les valeurs par 
défaut des paramètres des commandes Style de texte.
Pour réinitialiser tous les paramètres Style de texte :
m Cliquez sur le bouton Réinitialiser situé sur la ligne de la case à cocher Préréglage Style.
Enregistrement d’un style de texte personnalisé
Après modification des paramètres souhaités dans les fenêtres Style (notamment 
le dégradé ou l’éclat) ou Format (tel que le suivi ou le talus), vous pouvez enregistrer 
le style que vous venez de créer dans la catégorie Styles de texte de la Bibliothèque. 
Ces styles personnalisés peuvent être utilisés et appliqués exactement comme 
les styles prédéfinis.
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Remarque : tout style personnalisé enregistré dans la Bibliothèque est sauvegardé 
dans le dossier /Utilisateurs/nom d’utilisateur/Bibliothèque/Application Support/
Final Cut Studio/Motion/Bibliothèque/Text Styles/. La Bibliothèque de Motion est stockée à deux endroits sur votre ordinateur : le contenu en lecture seule installé avec 
Motion est placé dans le dossier /Bibliothèque/Applications Support/Final Cut Studio/
Motion/Bibliothèque (sauf si vous avez sélectionné un emplacement personnalisé lors 
de l’installation de Motion), alors que le contenu personnalisé créé par vos soins est 
sauvegardé dans le dossier /Utilisateurs/nom d’utilisateur/Bibliothèque/Application 
Support/Final Cut Studio/Motion/Bibliothèque.
Pour enregistrer dans la Bibliothèque un style de texte modifié :
1 Sélectionnez le texte comportant les paramètres modifiés que vous souhaitez 
enregistrer comme un style.
2 Dans la fenêtre Style, déroulez le menu local Préréglage Style, puis choisissez 
l’une des options suivantes :
Â Pour enregistrer un style avec uniquement les paramètres de la fenêtre Style, 
choisissez Enregistrer le style.
Â Pour enregistrer un style avec uniquement les paramètres de la fenêtre Format, 
choisissez Enregistrer le format.
Â Pour enregistrer un style avec les paramètres des deux fenêtres Style et Format, 
choisissez Tout enregistrer.
3 Dans la zone de dialogue Enregistrer ce préréglage dans la Bibliothèque, attribuez un nom 
à votre préréglage.
4 Cliquez sur Enregistrer.Chapitre 7 Utilisation de texte 679
Le préréglage personnalisé est enregistré dans la catégorie Styles de texte de la Bibliothèque. Les préréglages personnalisés sont identifiables dans la Bibliothèque à l’aide 
de la petite icône d’utilisateur qui apparaît en bas à droite de l’icône de style de texte 
de plus grande taille.
À propos du tramage et des groupes
Certaines opérations, tout comme l’application de divers filtres ou d’un masque, provoquent le tramage du groupe concerné. Ce tramage convertit le groupe en image bitmap. 
Toutes les couches de texte existant dans des groupes, le tramage affecte par conséquent 
la façon dont le texte interagit avec d’autres objets au sein de votre projet.
Remarque : un texte peut être tramé indépendamment du groupe dans lequel il est 
contenu. Dans ce cas, le tramage affecte la façon dont le texte interagit avec d’autres 
objets au sein de son propre groupe. Si vous appliquez, par exemple, un filtre Flou 
circulaire à un texte en espace 3D (comme un texte sur une trajectoire), il ne croise 
plus les autres objets du même groupe. Il est à noter que les mêmes opérations 
provoquent le tramage d’un groupe 3D et d’un texte 3D. Dans certains cas, l’activation 
de l’option Aplatir dans la fenêtre Présentation de l’Inspecteur Texte peut minimiser 
cet effet.
Style de texte personnalisé 
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Le tramage affecte les groupes 2D et 3D différemment. Lorsqu’un groupe 2D est tramé, 
les modes de fusion appliqués aux objets au sein du groupe n’ont plus aucune interaction 
avec les objets situés en dehors du groupe. Dans les illustrations suivantes, le groupe 2D 
non tramé qui contient le texte est réglé sur « Ajouter mode de fusion ». Le texte a alors 
une interaction avec l’objet situé au niveau inférieur dans la pile des couches.
Dans les illustrations suivantes, le groupe contenant le texte et l’image du haut du léopard est tramé. Son tramage a été déclenché par l’activation du paramètre Rognage 
dans l’onglet Propriétés du groupe. Les modes de fusion Ajouter du texte et Multiplier 
de l’image du léopard n’ont alors plus aucune interaction avec l’objet situé au niveau 
inférieur dans la pile des couches (l’image du bas du léopard). Veuillez noter que l’icône 
du groupe tramé apparaît désormais entourée d’un cadre (à gauche du groupe 
« Groupe - titres »).
Le groupe des titres n’est pas tramé. Les modes de fusion du texte et de l’image 
du haut du léopard affectent le groupe situé 
au niveau inférieur dans le projet.
Le groupe des titres est tramé, ce qui est 
indiqué par le cadre qui entoure son icône.
Les modes de fusion du texte et de l’image du 
haut n’affectent plus le groupe situé au niveau 
inférieur dans le projet.Chapitre 7 Utilisation de texte 681
Par ailleurs, si un groupe 3D est tramé, l’intégralité du groupe ne peut plus avoir aucune 
interaction avec les objets situés en dehors. Le groupe 3D tramé est alors traité comme 
un objet unique et il utilise l’ordre des couches, plutôt que l’ordre de profondeur, 
pour composer le projet.
Remarque : même si un groupe est tramé, les caméras et les lumières utilisées dans 
le projet ont toujours une interaction avec les objets situés au sein de ce groupe.
La modification des paramètres suivants déclenche le tramage d’un groupe :
Groupes 2D
Â Modification des paramètres de fusion (Opacité, Mode de fusion, Conserver l’opacité)
Â Activation de l’option Ombre portée
Â Activation de l’option Quatre angles
Â Activation de l’option Rognage
Â Application de n’importe quel filtre
Â Ajout d’un masque
Â Ajout d’une table lumineuse
Groupes 3D
Â Modification des paramètres de fusion
Â Application de certains filtres
Â Ajout d’une table lumineuse à un groupe 3D dont le paramètre Aplatir est activé 
(dans l’onglet Groupe de l’Inspecteur)
Une fois le tramage du groupe déclenché par l’une de ces opérations, vous observez 
les événements suivants :
Â Un indicateur de tramage (semblable à un voyant) apparaît en regard du paramètre 
dans l’onglet Propriétés.
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Â Un petit cadre apparaît autour de l’icône représentant le groupe 2D, le groupe 3D, 
l’émetteur, le réplicateur ou la couche de texte tramé (à gauche du nom du groupe 
correspondant) dans l’onglet Couches et la liste de couches de la Timeline.
Modification de la présentation du texte
La fenêtre Présentation contient des commandes de présentation du texte, notamment 
l’alignement, la justification et l’interligne. Vous pouvez également y créer un effet 
« machine à écrire » à l’aide du paramètre du même nom ou y régler le texte sur 
une trajectoire.
Pour afficher la fenêtre Présentation du texte :
m Dans l’Inspecteur, cliquez sur l’onglet Texte, puis sur le bouton Présentation. 
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Commandes Présentation du texte
Utilisez les commandes de présentation du texte pour déterminer l’agencement général 
de votre texte. Ces commandes permettent d’indiquer si le texte doit être présenté sur 
une seule ligne, sur un paragraphe avec des marges définies ou sur une trajectoire.
Méthode de présentation : indique si la présentation du texte est définie sur Type, 
Paragraphe ou Trajectoire. La méthode de présentation par défaut est Type, laquelle 
crée une seule ligne de texte.
Alignement : définit l’alignement des lignes de texte. Vous pouvez choisir d’aligner 
le texte à gauche, au centre et à droite.
Justification : définit la justification des lignes de texte. Vous avec le choix entre 
Aucune, Partielle et Totale.
Interligne : spécifie la distance entre chaque ligne de texte (interligne) sous forme 
d’incréments exprimés en points. Un glissement vers la droite (supérieur à 0) augmente 
l’espacement entre les lignes, tandis qu’un glissement vers la gauche (inférieur à 0) 
crée un espacement négatif des lignes.
Aplatir : dans les groupes 3D, les caractères d’un texte placé sur une trajectoire et soumis à des comportements risquent de subir des interférences au niveau de leur alignement linéaire. Par exemple, les caractères d’un texte peuvent sortir de leur plan du fait 
d’un comportement Simulation. Une fois la case Aplatir cochée, les caractères du texte 
demeurent dans l’espace 2D. Même si cette option est activée, le texte peut encore 
avoir une interaction avec les autres objets dans l’espace 3D, mais seulement en tant 
qu’image aplatie.
Un texte non aplati sur une trajectoire 3D peut 
traverser d’autres éléments d’un projet.684 Chapitre 7 Utilisation de texte
Une fois l’option Aplatir activée, les caractères du texte ne se déplacent plus dans 
l’espace 3D.
Remarque : lorsqu’une couche de texte pivotée selon l’axe Z est aplatie, le texte le plus 
éloigné de la caméra (plus loin sur l’axe Z) semble plus petit. Pour en savoir plus, 
voir « Compositing 3D » dans le manuel PDF Documentation supplémentaire de Motion.
∏ Astuce : lorsque vous manipulez du texte sur une trajectoire 3D, il peut devenir difficile 
à lire en fonction de son orientation et de sa distance par rapport à la caméra. Si vous 
devez le modifier, sachez que vous pouvez rapidement replacer une couche de texte 
dans son orientation d’origine (de face vers l’avant) grâce au bouton Isoler dans l’onglet 
Couches (ou dans la liste de couches de la Timeline) ou la commande Isoler du menu 
Objet.
Pour isoler un groupe ou une couche, procédez de l’une des manières suivantes :
Â Sous l’onglet Couches (ou dans la liste de couches de la Timeline), cliquez sur 
le bouton Isoler.
Â Cliquez sur la couche ou le groupe tout en maintenant la touche Contrôle enfoncée, 
puis choisissez Isoler dans le menu contextuel.
Â Choisissez Objet > Isoler.
Â Cliquez à nouveau sur le bouton Isoler pour revenir à la présentation précédente.
Remarque : si vous cliquez sur le bouton Isoler d’une caméra, vous activez l’affichage 
de cette caméra.
Face à la caméra : lorsque cette case est cochée, les caractères du texte font toujours 
face à la caméra, même si la caméra ou le texte est pivoté.
Image de texte aplatie n’existant que selon 
les axes X et Y. Elle interagit encore avec les 
autres objets, mais comme un objet aplati.
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Remarque : les caractères d’un texte étant des objets 2D (plats), ils ne sont pas visibles 
lorsque vous utilisez les vues orthogonales d’une caméra, telles que Gauche, Droite et 
Haut (sauf si la couche de texte ou les caractères sont pivotés en 3D). En effet, les vues 
orthogonales sont réalisées à angle droit par rapport aux objets dans le Canevas (perpendiculairement). Pour en savoir plus sur l’utilisation des caméras, voir « Compositing 3D » 
dans le manuel PDF Documentation supplémentaire de Motion.
Machine à écrire : ce groupe de commandes permet de créer un effet similaire à 
une machine à écrire. Vous pouvez animer avec des images clés l’effet machine à écrire 
pour qu’il survienne vers l’avant, vers l’arrière ou dans les deux directions.
Remarque : un comportement Animation de texte également appelé Machine à écrire 
vous permet de créer un effet de ce type vers l’avant, sans avoir à définir la moindre 
image clé.
Création d’un effet machine à écrire
Vous disposez de deux méthodes pour créer un effet de texte Machine à écrire : utilisez 
les paramètres Machine à écrire des commandes Présentation du texte ou appliquez 
le comportement Machine à écrire (dans la catégorie de comportement Animation de 
texte). Cette rubrique aborde l’utilisation des paramètres Machine à écrire dans la fenê-
tre Présentation. Pour en savoir plus sur le comportement de texte Machine à écrire, 
voir « Machine à écrire » à la page 723.
Commandes Machine à écrire
Utilisez les paramètres Machine à écrire pour indiquer la direction, les points de début 
et de fin, ainsi que le fondu entrant de l’effet machine à écrire. Ces paramètres doivent 
être animés pour afficher l’effet souhaité.
Début : définit le point de départ de l’effet machine à écrire (du côté gauche du texte). 
Si ce paramètre est réglé sur 0 % (sa valeur par défaut), le texte est entièrement soumis 
à l’effet machine à écrire. En revanche, s’il est défini sur 100 %, l’effet machine à écrire 
est inversé sur la totalité du texte. Si la valeur varie de 0 à 100 avec le temps, le texte est 
dactylographié de gauche à droite. Si la valeur varie de 100 à 0, le texte est dactylographié 
de droite à gauche.686 Chapitre 7 Utilisation de texte
Fin : définit le point final de l’effet machine à écrire (du côté droit du texte). Si ce paramètre est réglé sur 100 % (sa valeur par défaut), le texte est entièrement soumis à l’effet 
machine à écrire. En revanche, s’il est défini sur 0 %, l’effet machine à écrire est inversé 
sur la totalité du texte. Si la valeur varie de 100 à 0 avec le temps, le texte est dactylographié de droite à gauche. Si la valeur varie de 0 à 100, le texte est dactylographié de 
gauche à droite.
Fondu entrant : lorsqu’il est activé, ce paramètre applique un fondu entrant sur les caractères du texte. Lorsqu’il est désactivé, les caractères de texte apparaissent normalement.
Exemple : création d’un effet machine à écrire
Dans cet exemple, un texte est soumis à l’effet machine à écrire, de droite à gauche.
Pour créer un effet machine à écrire :
1 Sélectionnez le texte.
2 Placez-vous sur l’image à partir de laquelle vous souhaitez que l’animation commence.
3 Activer l’enregistrement.
4 Dans la fenêtre Présentation, définissez la valeur Fin des paramètres Machine à écrire sur 0.
Le texte disparaît (il n’est plus soumis à l’effet machine à écrire).
Remarque : vous pouvez également utiliser le menu Animation au lieu d’activer Enregistrer 
dans les commandes de lecture. Pour cela, cliquez sur l’icône du menu Animation en regard 
du paramètre Fin, puis choisissez Ajouter une image clé.
5 Placez-vous sur l’image sur laquelle vous souhaitez que l’animation se termine 
(que l’effet machine à écrire cesse).
6 Définissez la valeur Fin sur 100.
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7 Lancez la lecture du projet.
Le texte apparaît caractère par caractère, de gauche à droite (comme s’il était tapé 
sur une machine à écrire).
Pour créer un effet machine à écrire dans lequel les caractères surgissent, désactivez la case 
Fondu entrant.
Remarque : vous êtes autorisé à utiliser le paramètre Machine à écrire lorsque la méthode 
de présentation du texte est définie sur Type, Paragraphe (texte de plusieurs lignes) 
ou Trajectoire.
∏ Astuce : n’oubliez pas que vous pouvez appliquer des comportements Paramètre à 
la quasi-totalité des paramètres dans Motion. Par exemple, pour que le texte de l’exemple 
ci-dessus présente des imperfections et clignote au fur et à mesure qu’il apparaît, 
appliquez le comportement Rendre aléatoire au paramètre Fin :
Â Tout en maintenant la touche Contrôle enfoncée, cliquez sur la valeur Fin dans les commandes Machine à écrire, puis choisissez Rendre aléatoire dans le menu contextuel.
L’onglet Comportements apparaît et affiche les paramètres Rendre aléatoire. 
Les caractères du texte apparaissent de manière plus brutale et irrégulière.
Â Pour accentuer encore l’effet d’hésitation, réglez les paramètres Rendre aléatoire 
(par exemple, modifiez le mode Appliquer ou augmentez le paramètre Bruit).
Pour en savoir plus sur l’utilisation des comportements de Paramètre, voir « Application 
de comportements Paramètre » à la page 417.
Manipulation du texte sur une trajectoire
Vous pouvez créer un texte sur la trajectoire d’une ligne, d’un cercle, d’un rectangle, 
d’une vague ou le long du contour d’une forme ou d’un masque. Il est d’ailleurs possible de manipuler la trajectoire Spline ouvert d’un texte, afin qu’il se déplace dans un 
espace 3D. Vous pouvez modifier la forme d’une trajectoire de texte, ajouter ou supprimer des points de contrôle ou encore animer le texte le long de la trajectoire. De plus, 
il est toujours possible de modifier le texte sur une trajectoire, comme modifier les 
caractères ou la police du texte, le suivi, le crénage, etc. Les paramètres Style d’un texte 
sur une trajectoire peuvent également être modifiés.688 Chapitre 7 Utilisation de texte
Création de texte sur une trajectoire
Pour placer un texte sur une trajectoire, vous devez tout d’abord créer le texte, puis 
lui appliquer la méthode de présentation Trajectoire (via le menu local Méthode de 
présentation). Recourez ensuite aux paramètres Options de trajectoire pour modifier 
le texte sur sa trajectoire.
Pour créer du texte sur une trajectoire :
1 Sélectionnez le texte que vous souhaitez placer sur une trajectoire.
2 Dans la fenêtre Présentation de l’Inspecteur Texte, choisissez Trajectoire dans le menu 
local Méthode de présentation.
Les paramètres Options de trajectoire sont alors affichés.
3 Sélectionnez l’outil Texte (ou appuyez sur T), puis cliquez sur le texte dans le Canevas.
Important : l’étape 3 est importante. En effet, l’outil Texte doit être sélectionné pour 
visualiser ou éditer la trajectoire du texte.
Application de comportements à un texte sur une trajectoire
Vous avez la possibilité d’appliquer les comportements Simulation, Paramètre 
et Animation standard à un texte sur une trajectoire, ce qui vous permet de créer 
des animations extrêmement intéressantes et complexes en quelques secondes.
Pour en savoir plus sur l’utilisation des comportements Simulation et Paramètre, 
voir « Utilisation d’autres comportements avec du texte » à la page 733.Chapitre 7 Utilisation de texte 689
La trajectoire apparaît en dessous du texte. La forme par défaut de la trajectoire correspond à Spline ouvert et elle contient trois points de contrôle.
Modification de la forme de la trajectoire
Rappelez-vous que l’outil Texte doit être sélectionné afin de visualiser et d’éditer la trajectoire du texte. Conformez-vous aux règles suivantes pour modifier la forme de la trajectoire.
Pour modifier la trajectoire d’un texte :
Â Faites glisser un point de contrôle pour modifier la forme de la trajectoire.
Â Cliquez sur la trajectoire tout en maintenant la touche Option enfoncée ou doublecliquez dessus pour ajouter un point de contrôle.
Â Pour supprimer un point de contrôle, sélectionnez-le, puis appuyez sur la touche 
Suppr. Vous pouvez également cliquer sur le point tout en maintenant la touche 
Contrôle enfoncée, puis choisir Supprimer le point dans le menu contextuel.
Â Pour créer un point linéaire, cliquez sur un point tout en maintenant la touche Contrôle enfoncée, puis choisissez Linéaire dans le menu contextuel.
Â Pour créer un point lissé (Bézier), cliquez sur un point tout en maintenant la touche 
Contrôle enfoncée, puis choisissez Lissage dans le menu contextuel.
Remarque : si vous avez choisi B-Spline comme type de trajectoire, le menu contextuel 
affiche en plus l’option Lissage fort.690 Chapitre 7 Utilisation de texte
Â Pour verrouiller un point, cliquez dessus tout en maintenant la touche Contrôle 
enfoncée, puis choisissez Verrouiller le point dans le menu contextuel. Un point 
verrouillé ne peut pas être modifié.
Â Pour déverrouiller un point, cliquez dessus tout en maintenant la touche Contrôle 
enfoncée, puis choisissez Déverrouiller le point dans le menu contextuel.
Important : les points de contrôle de la trajectoire d’un texte sont modifiés de la même 
manière que les points de contrôle d’une forme. Pour en savoir plus, voir « Utilisation 
des formes et des masques » à la page 1071.
Remarque : si vous cliquez sur l’un des points de contrôle d’une trajectoire et maintenez 
le bouton de la souris enfoncé, une fenêtre d’information apparaît : elle vous indique 
le numéro du point (dans l’ordre selon lequel les points sont placés sur la trajectoire) 
et ses coordonnées X, Y et Z. Tous les points de contrôle d’une trajectoire sont également 
répertoriés par numéro dans la fenêtre Présentation de l’Inspecteur Texte.
Pour modifier la trajectoire d’un texte en 3D :
1 Si votre projet ne contient aucune caméra, ajoutez une caméra en procédant de 
l’une des manières suivantes :
Â Cliquez sur l’icône Nouvelle caméra dans la barre d’outils.
Â Choisissez Objet > Nouvelle caméra (ou appuyez sur les touches Option + 
Commande + C).
Remarque : si aucun des groupes de votre projet n’est à l’heure actuelle en 3D, une 
zone de dialogue vous demande si vous souhaitez transformer vos groupes 2D en 3D. 
Cliquez sur Basculer en 3D pour permettre à la caméra d’avoir un effet sur les groupes.
2 Remplacez la présentation par défaut de la caméra (Activée) par Haut :
Â Cliquez sur « Caméra activée » dans le coin supérieur gauche du Canevas (dans le menu 
Caméra), puis choisissez Haut dans le menu contextuel.
Â Choisissez Présentation > Présentation 3D > Haut.
Le texte n’est plus visible, car la caméra pointe maintenant vers le bas à la perpendiculaire du texte sur sa trajectoire (selon l’axe Y). Toutefois, la trajectoire du texte et ses points 
restent visibles. Dans le Canevas, l’icône de caméra en fil de fer jaune représente 
la caméra activée ajoutée au cours de l’étape 1.
Remarque : les commandes à l’écran de la trajectoire du texte sont disponibles pour 
toutes les présentations de caméra. Cet exemple utilise la vue d’en haut.
3 Faites glisser un point de contrôle pour ajuster la trajectoire du texte selon l’axe X, Y ou Z.Chapitre 7 Utilisation de texte 691
Remarque : la manipulation d’un texte sur une trajectoire 3D ne fonctionne que si 
la forme de la trajectoire est réglée sur Spline ouvert.
Si la trajectoire n’est plus sélectionnée, sélectionnez la couche de texte dans la liste 
de couches.
Remarque : si vous souhaitez indiquer des valeurs précises pour l’emplacement des 
points de contrôle, cliquez sur le triangle d’affichage en regard de Points de contrôle 
dans le groupe Options de trajectoire de la fenêtre Présentation. Les trois champs 
correspondent aux valeurs X, Y et Z.
4 Pour changer de présentation de caméra, cliquez sur « Haut » dans le coin supérieur 
gauche du Canevas, puis choisissez une autre présentation dans le menu Caméra.
Présentation d’en haut d’un texte sur une trajectoire 3D. 
Les valeurs Z des points de contrôle de droite et de 
gauche sont positives.
Présentation de caméra par la droite d’un texte sur une 
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5 Pour réinitialiser la présentation de la caméra, procédez de l’une des manières suivantes :
Â Choisissez Activée dans le menu Caméra.
Â Choisissez Présentation > Présentation 3D > Activée.
∏ Astuce : si vous utilisez du texte dans un projet 3D, tout particulièrement du texte qui se 
déplace à proximité de la caméra, il est conseillé de régler l’option Qualité de rendu sur 
Optimale dans le menu local ou le menu déroulant Présentation (choisissez Présentation 
> Qualité de rendu > Optimale). Toutefois, réglez cette méthode sur Normale en cours 
de travail, car l’option Optimale réduit considérablement l’interactivité de votre projet. 
Vous pouvez également régler la qualité de rendu au moment de l’exportation dans 
la zone de dialogue Options d’exportation : choisissez alors Exporter, cliquez sur Options, 
puis sélectionnez Optimale dans le menu local Qualité de rendu. Pour personnaliser une 
exportation, désactivez la case « Utiliser les réglages actuels du projet et du Canevas ».
Options de trajectoire
Ce groupe de commandes permet de spécifier la former initiale de la trajectoire 
du texte, puis de modifier la trajectoire ainsi que le texte sur cette trajectoire.
Forme de la trajectoire : détermine la forme de la trajectoire. Vous avez le choix entre : 
Spline ouvert, Spline fermé, Cercle, Rectangle, Vagues ou Géométrie.
Â Spline ouvert : forme par défaut. Il s’agit d’une ligne droite définie par deux points 
situés au début et à la fin de la trajectoire. Vous pouvez choisir de travailler avec des 
points de contrôle Bézier ou B-Spline. Cliquez n’importe où sur la trajectoire tout en 
maintenant la touche Option enfoncée (ou double-cliquez dessus) pour ajouter des 
points de contrôle.
Â Spline fermé : trajectoire fermée sur laquelle le dernier point est situé au même 
endroit que le premier. Vous pouvez choisir de travailler avec des points de contrôle 
Bézier ou B-Spline. Cliquez n’importe où sur la trajectoire tout en maintenant la touche 
Option enfoncée (ou double-cliquez dessus) pour ajouter des points de contrôle.
Â Cercle : version simplifiée de la forme Spline fermé, dans laquelle il est possible 
de modifier le rayon X ou Y pour créer un cercle ou une ellipse.Chapitre 7 Utilisation de texte 693
Â Rectangle : trajectoire fermée sur laquelle il est possible d’ajuster la largeur 
et la hauteur pour créer un carré ou un rectangle.
Â Vagues : trajectoire en forme d’onde (sinusoïdale) définie par deux points situés 
au début et à la fin de la trajectoire, et contrôlée par les paramètres Point d’arrivée, 
Amplitude, Fréquence, Phase et Humidité.
Â Géométrie : la couche se déplace le long du contour d’une forme ou d’un masque 
utilisé comme source pour la trajectoire. Il est possible d’utiliser une forme animée 
comme source de la trajectoire d’un texte. Vous pouvez, par exemple, appliquer 
un comportement Osciller à la forme d’un cercle et l’utiliser malgré tout comme 
forme source.
Commandes contextuelles
Selon l’option que vous avez choisie dans le menu local Forme de la trajectoire, 
d’autres commandes contextuelles sont mises à votre disposition :
Type de trajectoire : si vous avez sélectionné Spline ouvert ou Spline fermé pour la forme 
de la trajectoire, ce menu local vous permet de choisir l’une des deux méthodes 
de manipulation de la forme de la trajectoire : Bézier ou B-Spline.
Â Bézier : vous permet de manipuler la courbe d’images clés manuellement en faisant 
glisser les poignées.
Pour plus d’informations sur la création et l’ajustement des courbes de Bézier, 
voir « Modification des points de contrôle de Bézier » à la page 1102.
Â B-Spline : les courbes B-Spline se manipulent uniquement à l’aide des points 
(elles ne comportent pas de poignées tangentes). Les points ne sont d’ailleurs pas 
situés à la surface de la forme. En effet, chaque point de contrôle B-Spline est décalé 
par rapport à la surface de la forme, attirant cette section de la forme vers lui à la 
manière d’un aimant, pour créer la courbe. Les courbes B-Splines sont extrêmement 
lisses ; par défaut les formes B-Splines ne comportent aucun angle aigu, même si 
vous pouvez créer des courbes plus marquées, si besoin.
Pour en savoir plus sur la manipulation des courbes B-Splines, voir « Modification de 
points de contrôle B-Spline » à la page 1105.
Rayon : ce curseur est affiché si vous avez choisi Cercle comme forme de trajectoire. 
Il vous permet de modifier la taille de la trajectoire circulaire. Cliquez sur le triangle 
d’affichage pour régler séparément les rayons X et Y.
Remarque : si l’outil Texte est sélectionné, vous pouvez également utiliser les commandes à l’écran pour redimensionner le cercle. Appuyez sur Maj pour conserver les proportions X et Y des rayons.
Taille : ce curseur est affiché si vous avez choisi Rectangle comme forme de trajectoire. Il vous permet de modifier la taille de la trajectoire rectangulaire. Cliquez sur le 
triangle d’affichage pour régler séparément les échelles X et Y. 694 Chapitre 7 Utilisation de texte
Remarque : si l’outil Texte est sélectionné, vous pouvez également utiliser les commandes 
à l’écran pour redimensionner le rectangle. Appuyez sur Maj pour conserver les proportions X et Y des échelles.
Point de départ, Point d’arrivée, Amplitude, Fréquence, Phase et Humidité : ces commandes sont affichées si vous avez choisi Vagues comme forme de trajectoire.
Â Point de départ : détermine l’emplacement du point de départ par défaut de la trajectoire en forme de vague. Le curseur de valeur de gauche définit la coordonnée X 
du point de départ. Quant au curseur de droite, il définit sa coordonnée Y. Vous pouvez également ajuster le point de départ à l’aide des commandes à l’écran (activées 
par défaut si l’outil Texte est sélectionné). 
Â Point d’arrivée : détermine l’emplacement du point d’arrivée par défaut de la trajectoire en forme de vague. Le curseur de valeur de gauche définit la coordonnée X du 
point d’arrivée. Quant au curseur de droite, il définit sa coordonnée Y. Vous pouvez 
également ajuster le point d’arrivée à l’aide des commandes à l’écran (activées par 
défaut si l’outil Texte est sélectionné). 
Â Amplitude : curseur qui définit la moitié de la distance du point le plus élevé au point 
le plus bas dans la vague. Les valeurs élevées entraînent des vagues plus extrêmes.
Â Fréquence : curseur permettant de définir le nombre de vagues. Plus la valeur indiquée 
est importante, plus les vagues sont nombreuses.
Â Phase : cadran permettant de définir le pourcentage de décalage des vagues entre 
le point de départ et le point final de leur trajectoire. Si cette option est réglée 
sur 0 % (la valeur par défaut), les vagues commencent et se terminent à la moitié 
de la distance séparant les points le plus haut et le plus bas dans les vagues. À 90 %, 
les vagues commencent et se terminent au niveau du point le plus haut des vagues. 
À –90 %, les vagues commencent au niveau du point le plus bas des vagues. À 180 %, 
les vagues sont les mêmes qu’avec un réglage sur 0 %, mais elles sont inversées.
Â Humidité : curseur permettant de diminuer progressivement l’oscillation des vagues. 
Des valeurs positives entraînent la diminution des vagues vers l’avant (de gauche 
à droite). Des valeurs négatives ont l’effet inverse (de droite à gauche).
Source de la forme, menu local Vers, Attacher à la forme : ces commandes sont 
affichées si vous avez choisi Géométrie comme forme de trajectoire.
Â Source de la forme : cadre d’image définissant la couche (forme ou masque) 
à utiliser comme source de trajectoire animée.
Â Vers : menu local répertoriant toutes les couches du projet en cours pouvant servir 
de forme source pour la trajectoire animée.
Â Attacher à la forme : si cette case est cochée, la trajectoire d’animation suit la forme 
source à son emplacement d’origine. Dans le cas contraire, la trajectoire animée peut 
exister à un autre emplacement que sa forme source.Chapitre 7 Utilisation de texte 695
Remarque : si l’option « Attacher à la forme » est activée, vous ne pouvez pas déplacer la couche à un autre emplacement.
Pour en savoir plus sur l’utilisation d’objets spline comme forme source de trajectoire 
de texte, voir « Utilisation de la forme Géométrie pour la source d’une trajectoire » à 
la page 696.
Autres commandes Options de trajectoire
Les commandes relatives aux paramètres suivants sont proposées quelle que soit 
la forme de la trajectoire :
Décalage de la trajectoire : détermine le début du texte sur la trajectoire. Animez 
cette valeur pour déplacer le texte le long d’une trajectoire. À 0 %, le premier caractère 
du texte se trouve à l’extrémité gauche de la trajectoire. À 100 %, il se trouve à l’extré-
mité droite de la trajectoire.
Bouclage : disponible si vous avez choisi Spline ouvert ou Vagues (une forme ouverte) 
comme forme de trajectoire, cette option enveloppe le texte à partir de la fin de la trajectoire autour du premier point de la trajectoire.
À l’intérieur de la trajectoire : lorsque la case À l’intérieur de la trajectoire est activée, 
la ligne standard du texte sur une trajectoire en boucle est modifiée afin que le texte 
apparaisse à l’intérieur de la boucle.
Aligner sur la trajectoire : aligne le texte sur la forme de la trajectoire. Lorsque la case 
est désactivée, tous les caractères du texte s’alignent verticalement, quelle que soit 
la forme de la trajectoire.
Points de contrôle : affichent les positions X et Y de tous les points de contrôle de 
la trajectoire. Utilisez les curseurs pour ajuster la position des points de contrôle à l’aide 
de l’Inspecteur. Un paramètre supplémentaire relatif à la position Z apparaît si la forme 
de trajectoire choisie est Spline ouvert.696 Chapitre 7 Utilisation de texte
Utilisation de la forme Géométrie pour la source d’une trajectoire
La rubrique suivante décrit l’utilisation de la forme Géométrie comme source de trajectoire 
d’un texte.
Pour utiliser la forme Géométrie comme source de trajectoire d’un texte :
1 Importez (ou dessinez) la forme que vous souhaitez utiliser comme source de trajectoire.
2 Sélectionnez le texte sur la trajectoire, puis choisissez Géométrie dans le menu local 
Forme de la trajectoire.
Le cadre Source de la forme apparaît dans l’Inspecteur.
3 Dans l’onglet Couches, faites glisser la forme vers le cadre Source de la forme.
4 Lorsque le pointeur devient une flèche courbe, relâchez le bouton de la souris.
Une vignette représentant la forme apparaît dans le cadre et elle est utilisée comme 
source pour la forme de la trajectoire du texte.Chapitre 7 Utilisation de texte 697
Remarque : vous pouvez avoir envie de désactiver la forme source dans l’onglet 
Couches, afin qu’elle ne soit pas visible dans votre projet.
Pour sélectionner une autre forme Géométrie comme source de trajectoire d’un texte :
m Cliquez sur le menu local « Vers » (situé en regard du cadre Source de la forme), 
puis sélectionnez la couche à utiliser comme forme source de la trajectoire du texte.
Modification d’un texte sur une trajectoire
Le texte sur une trajectoire peut toujours être modifié, ce qui inclut la modification des 
paramètres Format, tels que la police, le suivi ou le crénage, ainsi que la modification 
des paramètres Style, tels que le changement de la couleur et de l’opacité (y compris 
l’application de styles ou de dégradés).
Si vous ajoutez des caractères à un texte positionné sur une trajectoire, celle-ci peut 
s’avérer trop courte. Dans les images suivantes, la première montre le texte d’origine 
placé sur une trajectoire. La seconde affiche du texte en plus. Notez que sur la seconde 
image, où des caractères ont été ajoutés, la trajectoire est plus courte que le texte.
Texte d’origine placé sur une trajectoire Caractères supplémentaires ajoutés au texte 
d’origine
Séquence mise à disposition avec l’aimable autorisation de National Geographic Television et Film Library.698 Chapitre 7 Utilisation de texte
Pourrallonger une trajectoire de texte :
m Alors que l’outil Texte est sélectionné, faites glisser le dernier point de contrôle vers 
la fin du texte.
Lors du glissement, appuyez sur la touche Maj afin de contraindre la trajectoire sur 
une ligne droite. Une fois la trajectoire rallongée, vous pouvez ajouter des points de 
contrôle pour augmenter le contrôle sur la forme de la trajectoire.
Animation de texte sur une trajectoire
Il est possible d’animer le texte pour qu’il se déplace à travers la trajectoire.
Pour animer du texte sur une trajectoire :
1 Créez la trajectoire le long de laquelle le texte va se déplacer
2 Placez-vous sur l’image sur laquelle vous souhaitez que l’animation commence, 
puis activez l’enregistrement.
Remarque : n’oubliez pas que l’utilisation de raccourcis clavier en mode d’édition 
du texte peut entraîner la saisie de caractères supplémentaires dans votre texte.
3 Dans la fenêtre Présentation, réglez le curseur Décalage de la trajectoire ou le curseur 
de valeur sur la longueur dont vous souhaitez déplacer le texte sur la trajectoire. Chapitre 7 Utilisation de texte 699
Une image clé est ajoutée au paramètre Décalage de la trajectoire.
Une valeur positive déplace le texte vers la droite et une valeur négative le déplace vers 
la gauche. Vous pouvez saisir des valeurs supérieures à 100 % ou inférieures à 0 % grâce 
au curseur de valeur. Une valeur supérieure à 100 % déplace le texte complètement en 
dehors de la trajectoire vers la droite, alors qu’une valeur inférieure à 0 % le déplace en 
dehors de la trajectoire, vers la gauche. Dans l’image suivante, le paramètre Décalage 
de la trajectoire est réglé sur 105 %, ce qui a pour effet de décaler le texte vers la droite, 
en dehors de sa trajectoire.
4 Placez-vous sur l’image sur laquelle vous souhaitez arrêter l’animation (ou définir l’image 
clé suivante).
5 Réglez le curseur Décalage de la trajectoire ou le curseur de valeur afin de repositionner 
le texte sur la trajectoire.
6 Lisez le projet pour constater le déplacement du texte le long de la trajectoire.
7 Désactivez l’enregistrement.
Cette icône indique 
la présence d’une image 
clé à la position actuelle 
de la tête de lecture.700 Chapitre 7 Utilisation de texte
Utilisation de marges de texte
Par défaut, la méthode de présentation du texte est définie sur Type, ce qui crée une 
longue chaîne de texte, jusqu’à ce que vous insériez manuellement un saut de ligne. 
Il existe plusieurs manières de créer et de régler les marges d’un texte, notamment 
l’utilisation des commandes à l’écran et de la fenêtre Présentation de l’Inspecteur Texte. 
Vous pouvez modifier une marge avant ou après la création d’un texte.
Options de marge
Ce groupe de commandes, qui est accessible lorsque la Méthode de présentation 
est définie sur Paragraphe, définit la taille et l’emplacement des marges de texte.
Marges gauche, droite, supérieure et inférieure : utilisez ces commandes pour définir 
les marges de la présentation du texte dans le Canevas. Pour activer les commandes 
Marge, la Méthode de présentation doit être définie sur Paragraphe.
Création d’une marge de texte
Vous pouvez créer une marge personnalisée à l’aide des commandes Marge affichées 
par la fenêtre Présentation de l’Inspecteur Texte ou en traçant un cadre de sélection de 
texte dans le Canevas.
Pour créer des marges de texte grâce à l’outil Texte :
1 Sélectionnez l’outil Texte (ou appuyez sur T), puis faites glisser le pointeur dans le Canevas.
Lorsque vous relâchez le bouton de la souris, un cadre de sélection de texte apparaît.
Commandes Marge
Pour afficher les commandes 
Marge, Méthode de présentation doit correspondre à 
Paragraphe.Chapitre 7 Utilisation de texte 701
Remarque : vous pouvez créer un cadre de sélection de texte (créer des marges) 
qui dépasse des bords du Canevas.
Dès que vous relâchez le bouton de la souris, le point d’insertion clignote dans le cadre 
de sélection et vous pouvez saisir du texte dans le Canevas ou dans l’éditeur de texte 
de la fenêtre Format. La méthode de présentation est automatiquement définie 
sur Paragraphe.
2 Pour redimensionner les marges de texte, assurez-vous que l’outil Texte est sélectionné, puis faites glisser une poignée d’échelle du cadre de sélection.
Remarque : vous pouvez également redimensionner les marges du cadre de sélection 
de texte à l’aide des commandes Marge de la fenêtre Présentation de l’Inspecteur Texte 
(reportez-vous à l’étape 3 de l’exemple suivant).
3 Appuyez sur la touche Échap ou cliquez sur l’outil Sélectionner/Transformer pour sélectionner le cadre de sélection de texte et quitter le mode de modification de texte.
Remarque : n’utilisez pas l’outil Sélectionner/Transformer pour redimensionner les marges 
du cadre de sélection de texte. Si vous sélectionnez une poignée d’échelle d’un cadre 
de sélection de texte à l’aide de l’outil Sélectionner/Transformer et que vous effectuez 
un redimensionnement, ce n’est pas seulement le cadre de sélection qui est redimensionné, mais le texte proprement dit.702 Chapitre 7 Utilisation de texte














 























 

